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Chapter 1 - What's New for FortiOS 5.6

What's new in FortiOS 5.6

This document highlights and describes new features for the following versions of FortiOS 5.6:

l FortiOS 5.6.4, see What's New for FortiOS 5.6.4 on page 58.
l FortiOS 5.6.3, see How this guide is organized for links to 5.6.3 new feature descriptions.
l FortiOS 5.6.2, no new features were added to FortiOS 5.6.2. This is a bug fix release. See the Resolved Issues

section of the FortiOS 5.6.2 Release Notes for details.
l FortiOS 5.6.1, see How this guide is organized for links to 5.6.1 new feature descriptions.
l FortiOS 5.6.0, see How this guide is organized for links to 5.6.0 new feature descriptions

Most new feature descriptions include a feature number that references the internal Fortinet ID used to track the
feature.

How this guide is organized
The following sections highlight some of the higher profile new FortiOS 5.6 features.

l What's New for FortiOS 5.6.4
l FortiGate VM enhancements for AWS, Azure, Google, SDN connectors and more (5.6.3)
l New Dashboard Features
l New Fortinet Security Fabric features
l Security Fabric Audit and Fabric Score
l FortiExplorer for iOS
l NGFW Policy Mode (397035)
l Transparent web proxy (386474)
l New FortiView Endpoint Vulnerability Scanner chart (378647)
l FortiClient Profile changes (386267, 375049)
l Application Control is now standard with FortiCare support
l Real time logging to FortiAnalyzer and FortiCloud
l FortiGate Logs can be sent to syslog servers in Common Event Format (CEF) (300128)
l Controlled failover between wireless controllers
l Multiple PSK for WPA Personal (393320)
l VXLAN support (289354)
l New PPPoE features
l Adding Internet services to firewall policies (389951)
l Combining source and destination NAT in the same policy (388718)
l NP6 Host Protection Engine (HPE) adds protection for DDoS attacks (363398)

All of the other new features in FortiOS 5.6 are organized alphabetically by subject:
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l Getting Started (5.6.3)
l Getting Started (5.6.1)
l Getting Started (5.6)
l Authentication (5.6.3)
l Authentication (5.6.1)
l Authentication (5.6)
l FortiOS Carrier (5.6.3)
l FortiOS Carrier (5.6.1)
l Device identification (5.6)
l Device identification (5.6)
l Diagnose command changes (5.6.1)
l Diagnose command changes (5.6)
l Explicit web proxy (5.6)
l Firewall (5.6.3)
l Firewall (5.6.1)
l Firewall (5.6)
l Managed FortiSwitch OS 3.6.0 (FortiOS 5.6.3)
l Managed FortiSwitch OS 3.6.0 (FortiOS 5.6.1)
l Managed FortiSwitch OS 3.6.0 (FortiOS 5.6)
l FortiView (5.6.3)
l FortiView (5.6.1)
l FortiView (5.6)
l FortiGate VM enhancements for AWS, Azure, Google, SDN connectors and more (5.6.3)
l FortiGate VM (5.6.0)
l Hardware acceleration (5.6.3)
l Hardware acceleration (5.6.1)
l Hardware acceleration (5.6)
l High Availability (5.6.1)
l High Availability (5.6)
l IPsec VPN (5.6.3)
l IPsec VPN (5.6.1)
l IPsec VPN (5.6)
l IPv6 (5.6.3)
l IPv6 (5.6.3)
l Logging and Reporting (5.6.3)
l Logging and Reporting (5.6.1)
l Logging and Reporting (5.6)
l Modem (5.6.1)
l Networking (5.6.3)
l Networking (5.6.1)
l Networking (5.6)
l New RFCs
l Sandbox Integration (5.6.1)

FortiOS Handbook for FortiOS 5.6.7
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l Security Profiles (5.6.3)
l Security Profiles (5.6.1)
l Security Profiles (5.6)
l Server Load balancing (5.6.1)
l Session-aware Load Balancing (SLBC) (5.6.1)
l SSL VPN (5.6.3)
l SSL VPN (5.6.1)
l SSL VPN (5.6)
l System (5.6.3)
l System (5.6)
l VDOMs (5.6.0)
l VDOMs (5.6.0)
l VoIP/SIP (5.6)
l WiFi (5.6.3)
l WiFi (5.6.1)
l WiFi (5.6)

What's New for FortiOS 5.6.4

This section lists new features added to FortiOS 5.6.4 with links to the FortiOS Handbook for more information.
FortiOS Handbook chapters will be updated for 5.6.4 only to document new features or to publish corrections or
improvements to the content.

Authentication
l Authentication binds to MAC address on page 382
l New RADIUS accounting start message options, see RADIUS accounting start message options on page 394
l IPv6 TACACS+ server IP address on page 407
l Login credentials for guest users shown in clear text on GUI and voucher on page 429

Firewall
l Using a FortiCache as a cache service on page 1174

FortiView
l Increased visibility of interactivity in FortiView on page 1254
l Automatic synchronization of log display location on page 1254

FortiWiFi and FortiAP
l FortiAP LED Blinking on page 1484
l Wireless controller optimization for large deployment - AP image upgrade on page 1484

58 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New for FortiOS 5.6.4

Hardware acceleration
l Per-session accounting is supported for FortiGates with NP6lite processors, Enabling per-session accounting for

offloaded NP6 or NP6lite sessions on page 1620

High availability
l FGSP configuration synchronization changes, see Synchronizing the configuration on page 1995
l Changes to get system status ha command output, see Viewing cluster status from the CLI on page 1898

IPsec VPN
l Updates to IPsec VPNWizard options on page 2018

Logging and reporting
l Automatic synchronization of log display location on page 2288

Security profiles
l Configuring the FortiClient offline grace period on page 2921
l Excluding industrial IP signatures on page 2958

SSL VPN
l Changes to Tunnel Mode Client Options logic on page 3032
l Changes to HTTP header information on page 3081

Virtual FortiOS
l SDN connector addressing on page 3418
l Support for KVM-based hypervisor in AWS on page 3419
l HA support for GCP on page 3422
l Other Virtual FortiOS Products on page 3416
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What's New in previous versions of FortiOS 5.6

This chapter briefly highlights some of the higher profile new FortiOS 5.6 features, some of which have been
enhanced for FortiOS 5.6.1 and FortiOS 5.6.3.

FortiGate VM enhancements for AWS, Azure, Google, SDN connectors and more
The realm of virtual computing has become mainstream and not only does this mean that security appliances can
also be virtual, there is also a requirement for security appliances in a virtual environment. These environments
can be the publicly available platforms such as Amazon Web Services, Azure and Google Cloud Platform or they
can be Software Defined Networks (SDN) such as those made by Cisco, HP, Nuage and OpenStack. For that
reason, not only is the number of Virtual FortiOS variations growing along with what they can do, a number of the
new features being introduced deal with integrating FortiOS into these environments. See FortiGate VM
enhancements for AWS, Azure, Google, SDN connectors and more (5.6.3) on page 186.

Recipes are now being also published for the cloud-based and SDN environments on the Fortinet Cookbook
website.

l http://cookbook.fortinet.com/amazon-web-services-aws/
l http://cookbook.fortinet.com/cisco-aci/
l http://cookbook.fortinet.com/microsoft-azure/
l http://cookbook.fortinet.com/nuage-vsp/

Fortinet Security Fabric enhancements
Security Fabric features and functionality continue to evolve. New features include improved performance and
integration, a security audit function that finds possible problems with your network and recommends solutions,
security fabric dashboard widgets, improved device detection, and the remote login to other FortiGates on the
fabric. See New Fortinet Security Fabric features on page 62.

Security Fabric Audit
The Security Fabric Audit allows you to analyze your Security Fabric deployment to identify potential
vulnerabilities and highlight best practices that could be used to improve your network’s overall security and
performance. See Security Fabric Audit and Fabric Score on page 73.

Re-designed Dashboard
The Dashboard has been enhanced to show more information with greater flexibility and more functionality. See
New Dashboard Features on page 79 for details.

NGFW Policy Mode
You can operate your FortiGate in NGFW policy mode to simplify applying Application control and Web Filtering
to firewall traffic. See NGFW Policy Mode (397035) on page 96.

Flow-based inspection with profile-based NGFWmode is the default inspection mode in FortiOS 5.6.
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Transparent web proxy
In addition to the Explicit Web Proxy, FortiOS now supports a Transparent web proxy. You can use the
transparent proxy to apply web authentication to HTTP traffic accepted by a firewall policy. See Transparent web
proxy (386474) on page 88.

Controlled failover between wireless controllers
Administrators can now define the role of the primary and secondary controllers on the FortiAP unit, allowing the
unit to decide the order in which the FortiAP selects a FortiGate unit and how the FortiAP unit fails over to a
backup FortiGate unit if the primary FortiGate Fails. See Controlled failover between wireless controllers on page
104.

FortiView Endpoint Vulnerability chart
A new FortiView chart that tracks vulnerability events detected by the FortiClients running on all devices
registered with the FortiGate. See New FortiView Endpoint Vulnerability Scanner chart (378647) on page 99.

FortiClient Profile changes
FortiClient profiles have been re-organized and now use the FortiGate to warn or quarantine endpoints that are
not compliant with a FortiClient profile. See FortiClient Profile changes (386267, 375049).

Adding Internet services to firewall policies
Internet service objects can be added to firewall policies instead of destination addresses and services. See
Adding Internet services to firewall policies (389951).

Source and destination NAT in a single Firewall policy
Extensions to VIPs support more NAT options and other enhancements. See Combining source and destination
NAT in the same policy (388718).

Other highlights
l Application Control is now standard with FortiCare support
l Real time logging to FortiAnalyzer and FortiCloud
l Multiple PSK for WPA Personal (393320)
l VXLAN support (289354)
l NP6 Host Protection Engine (HPE) adds protection for DDoS attacks (363398)
l FortiGate Logs can be sent to syslog servers in Common Event Format (CEF) (300128)
l New PPPoE features
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New Fortinet Security Fabric features
In FortiOS 5.6, the Security Fabric (previously known as the Cooperative Security Fabric) has been expanded in
several ways to add more functionality and visibility.

One of the most important functional changes is that FortiAnalyzer is now a required part of the Security Fabric
configuration. Also, two important new features, Security Fabric Audit and Fabric Score, have been added to
provide a method to continually monitor and improve the Security Fabric configuration.

Many changes have been made through FortiView to improve the visibility of the Security Fabric. More
information is now displayed and you can access downstream FortiGates directly from the root FortiGate’s
FortiView display.

Other smaller improvements have been made throughout the Security Fabric, with a focus on improving
communication between devices.

In FortiOS 5.6.1, the new updated GUI design consolidates the Security Fabric features together under a new
menu and has many new topological changes to provide greater visibility into the connectivity of your networked
devices. This includes adding more Fortinet products to the topology and widgets. Other topology improvements
include enhanced IPsec VPN detection (which now includes detection of downstream FortiGates) and support for
SD-WAN. Smaller changes have also been made to add more information to device tooltip alerts in the Physical
and Logical Topology views.

Setting up the Fortinet Security Fabric in FortiOS 5.6

See the following FortiGate Cookbook recipes to get started in setting up the Security Fabric in FortiOS 5.6:

l Installing a FortiGate in NAT mode
l Security Fabric installation

Security Fabric between remote networks by enabling FortiTelemetry for IPsec VPN interfaces

You can now enable FortiTelemetry for IPsec VPN interfaces. The Security Fabric can now detect the
downstream FortiGate through the IPsec VPN interface. This allows you to send FortiTelemetry communication
over a Gateway-to-Gateway IPsec VPN tunnel between two remote networks. One of the networks would contain
the root FortiGate and the network at the other end of the IPsec VPN tunnel can connect to the root FortiGate's
Security Fabric.

In the GUI, to enable FortiTelemetry

1. Go to Network > Interfaces and edit your IPsec VPN interface.

2. Under Administrative Access enable FortiTelemetry.
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Your IPsec VPN interface will automatically be added to the FortiTelemetry enabled interface list under Security
Fabric > Settings.

In the CLI, enter the following commands:

config system interface
edit <vpn_name>
set fortiheartbeat enable

end

Re-designed Security Fabric setup

A new updated GUI menu consolidates the Security Fabric features in one location. This includesPhysical
Topology, Logical Topology, Audit, and Settings. For more details, see the illustration below:
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Improved Security Fabric Settings page

The Security FabricSettings page has been updated to act as a centralized location for you to enable
connectivity to other Fortinet products. Navigate to Security Fabric > Settings.

Changes to the Settings page include the following:

l The previousEnable Security Fabric option has been replaced with an option to enable FortiGate Telemetry.
l The previousDownstream FortiGates option has been replaced with Topology to show multiple devices.

See the screen shot below:

Security Fabric dashboard widgets

New dashboard widgets for the Security Fabric put information about the status of the Security Fabric at your
fingertips when you first log into your FortiGate.
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The FortiGate dashboard widget has been updated to include the following Fortinet products: FortiGate (core),
FortiAnalyzer (core), FortiSwitch, FortiClient, FortiSandbox, and FortiManager. See the screen shot below:

You can hover over the icons along the top of the Security Fabric widget to get a quick view of the status of the
Security Fabric. Available information includes the FortiTelemetry status and the status of various components of
in the Security Fabric.

The Security Fabric Score widget shows the Security Fabric Audit score for the Security Fabric and allows you to
apply recommended changes right from the dashboard.

Physical and Logical FortiView improvements

The FortiView Physical and Logical Topology pages now display the following improvements:

l Shows both FortiGates in an HA configuration
l Shows FortiAPs
l Lists FortiAnalyzer and FortiSandbox as components of the Security Fabric
l Highlights the current FortiGate
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l Displays Link Usage in different colors
l Ranks Endpoints by FortiClient Vulnerability Score and by Threat Score ( see below, for more information)
l Displays user avatars
l Recognizes servers as a device type
l Introduces a search bar to help locate specific devices in the Security Fabric

Updated Physical and Logical Topology legend

On the Physical Topology and Logical Topology pages, the Security Fabric legend has been updated. See
the screenshot below:

New option to minimize the Topology

This new feature allows you to minimize portions of the Physical and Logical Topology. This makes it easy to view
your entire topology, or minimize portions to focus in on a specific area. See the screenshot below:
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Security Fabric Topology shows new resource information alerts

The enhanced Security Fabric topology now shows CPU Usage and Memory Usage alerts in the device
information tooltip. It also displays a warning if the FortiGate is in conserve mode. Note that the CPU usage,
memory usage and conserve mode data are drawn from the data that was last loaded from the FortiGate, not
real-time data.

You can see the new CPU Usage and Memory Usage fields shown in the tooltip below:
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The Conserve mode warning is shown below:

SD-WAN information added to Security Fabric topology

The Security Fabric topology now includes SD-WAN. Enhancements include greater visibility into where the data
comes from and goes to, link saturation indicators, and detailed tooltip explanations.

The following SD-WAN information has been integrated into the Security Fabric topology:

l The tooltip for the SD-WAN interface now includes load balancing settings.
l In the Security Fabric Logical Topology, SD-WAN and its interface members will appear above all interfaces.
l If connected to an upstream FortiGate, one link between the exact SD-WANmember and the upstream FortiGate

will appear.
l If connected to a destination bubble, links between each enabled member and the destination bubble appear.
l Interface bandwidth and link utilization for other interfaces (WAN role interface) have been temporarily removed

and will be added back in later.
l Fixes have been made to show vulnerabilities for multiple MAC addresses (402495) and to show the FortiSwitch

serial and port (389158).

For more details see the screenshot below:
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SD-WAN Monitor Support added to Security Fabric (417210)

The Security Fabric now retrieves monitor information from all members of the Security Fabric and displays it in
the GUI of the root FortiGate. Support was added for the Routing Monitor, DHCPMonitor and User Quarantine
Monitor.

You can use the new drop down menu shown below to select the Security Fabric members:

FortiCache support for the Security Fabric (435830)

FortiGates in the Security Fabric can now use FortiCache as a remote cache service. Previously, FortiCache was
supported via WCCP re-direct only, but now FortiGates can use it as a local cache rather than redirecting via
WCCP.

In the GUI, follow the steps below:

1. Go to Security Fabric > Settings and enable HTTP Service.

2. Set Device Type to FortiCache and add the IP addresses of the FortiCache devices.

3. You can also select Authentication and add a password if required. See the screenshot below:
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In the CLI, enter the following commands:

config wanopt forticache-service
set status enable
set local-cache-id <local-cache-id>
set remote-forticache-id <remote-forticache-id>
set remote-forticache-ip <remote-forticache-ip>

end

l status - Enable/disable using FortiCache as web-cache storage
l disable - Use local disks as web-cache storage
l enable - Use a remote FortiCache as web-cache storage
l local-cache-id - The cache ID that this device uses to connect to the remote FortiCache
l remote-forticache-id - The ID of the FortiCache that the device connects to
l remote-forticache-ip - The IP address of the FortiCache the device connects to

Enhanced Security Fabric audit tests for FortiGuard licenses (409156)

The Security Fabric audit now has separate audit tests for FortiGuard licenses based on whether the FortiGuard
license is valid, expired, never been activated, or temporarily unavailable. Previously, the audit test performed
one batch test on all FortiGuard licenses, regardless of the status of the licenses. Recommendations for
individual licenses are also provided in the GUI tooltips.

You can see the new breakdown of pass or fail actions shown below:

l License valid = pass
l License expired = fail
l License never activated = fail
l License is unavailable (connection issue with FortiGuard) = pass

If a required Feature Visibility is disabled, the audit test for it will not show vulnerabilities. The audit will show a
score of zero (or a pass). Go to System > Feature Visibility (previously the Feature Select menu) to make any
changes.

In the GUI, follow the steps below to check the status of your FortiGuard licenses:

1. Go to Security Fabric > Audit to check the status of your FortiGuard licenses.

2. Follow the steps in the Security Fabric Audit wizard.
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3. Expand Firmware & Subscriptions, and look at the FortiGuard License Subscriptions section to verify
whether any recommended action is required. See the example below:

FortiClient Vulnerability Score

Endpoints in the Security Fabric topology are now ranked by their FortiClient Vulnerability Score. This score is
calculated by the severity of vulnerabilities found on the endpoint:

l critical vulnerability = 100 points
l high vulnerability = 50 points
l medium vulnerability = 5 points
l low vulnerability = 2 points
l info vulnerability = 1 point

FortiView Consolidation

Information about the Security Fabric can now be seen throughout the FortiView dashboards on the upstream
FortiGate, when the real-time view is used.

l You can right-click on an entry and select View Aggregated Details to see more information.
l The upstream FortiGate filters information to avoid counting traffic from the same hosts multiple times on each

hop.

The upstream FortiGate also now has the option to end downstream FortiGate sessions or quarantine endpoints
that connect to downstream FortiGates.

Remote login to downstream FortiGates

You can now log into downstream FortiGates from the upstream FortiGate, by right-clicking on the downstream
FortiGate when viewing the Security Fabric’s topology using FortiView.
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Logging Consolidation and Improvements

Several changes have been made to improve logging for a Security Fabric.

Sending all logs to a single FortiAnalyzer

By default, all FortiGates in the Security Fabric now send logs to a single FortiAnalyzer. The connection to the
FortiAnalyzer is configured on the upstream FortiGate, then the settings are pushed to all other FortiGates.

In FortiOS 5.6, a FortiAnalyzer is required for the root FortiGate in the Security Fabric; however, downstream
devices can be configured to use other logging methods through the CLI:

config system csf
set logging-mode local

end

Data Exchange with FortiAnalyzer

The following information about the Security Fabric configuration is now sent to the FortiAnalyzer:

l Topology info
l Interface roles
l LAT / LNG info
l Device asset tags

Retrieving Monitor Information

Monitors on the upstream FortiGate, such as the VPNMonitor, Route Monitor, and User Quarantine, can now
view the information from downstream devices. You can use the button in the top right corner of the screen to
change the FortiGate information that is displayed.

Log Settings

Log statistics for each FortiGate in the Security Fabric are now shown when you go to Log & Report > Log
Settings.
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Device Tree

The entire Security Fabric tree is now updated upward, and each node has an updated state of the whole subtree.
The content is saved in the local file and upon request from the GUI or a diagnose command (dia sys csf
downstream) it can be retrieved.

Security Fabric Audit and Fabric Score
This chapter contains information about the Security Fabric Audit and Fabric Score, which together provide a
method to continually monitor and improve your Security Fabric's configuration.

What is the Security Fabric Audit?

The Security Fabric Audit is a feature on your FortiGate that allows you to analyze your Security Fabric
deployment to identify potential vulnerabilities and highlight best practices that could be used to improve your
network’s overall security and performance.

Why should you run a Security Fabric Audit?

Using the Security Fabric Audit helps you to tune your network’s configuration, deploy new hardware and/or
software, and gain more visibility and control of your network. Also, by checking your Security Fabric Score, which
is determined based on how many checks your network passes/fails during the Audit, you can have confidence
that your network is getting more secure over time.

Running a Security Fabric Audit

The Security Fabric Audit must be run on the root FortiGate in the Security Fabric.

The Security Fabric Audit can be found by going to Security Fabric > Audit. In the first step, all detected
FortiGates are shown.
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In the second step, the audit is performed and a list of recommendations are shown. Two views are available:
Failed orAll Results. These views can be further segmented so that you view results from all FortiGates or just
a specific unit.

In each view, a chart appears showing the results of individual checks. The following information is shown: the
name and a description of the check, which FortiGate the check occurred on, the checks result on your overall
security score, and any necessary recommendations.

If you hover the mouse over the Result for a check, you can get a breakdown on how this score was determined.
For more information about this, see "Security Fabric Score" on page 78.
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In Step Three of the Audit, Easy Apply recommendations are displayed and can be applied. By using Easy
Apply, you can change the configuration of any FortiGate in the fabric.

For other recommendations, further action is required if you wish to follow the recommendation.

You can also view Audit recommendations for specific devices using the FortiView Topology consoles. If a
recommendation is available for a device, a circle containing a number appears. The number shows how many
recommendations are available, while the color of the circle shows the severity of the highest check that failed
(red is critical, orange is high, yellow is medium, and blue is low).

Logging for the Security Fabric Audit

An event filter subtype is available for the Security Audit. Every time an audit is run, event logs are created on the
root FortiGate that summarize the results of the audit, as well as details into the individual tests.

Syntax
config log eventfilter
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set security-audit {enable | disable} (enabled by default)
end

Security Fabric Audit Checks

The Security Fabric Audit performs a variety of checks when analyzing your network. All checks are based on your
current network configuration, using realtime monitoring. The Audit runs these checks across all FortiGates in the
Security Fabric.

Firmware & Subscriptions

Goal Severity Check Recommendation Easy
Apply?

Compatible Firmware Critical
All FortiGates in the Security
Fabric should run the same

firmware version.
Run same version as root. No

FortiCare Support Critical FortiGate should be registered
with FortiCare. Register with FortiCare. No

FortiGuard License
Subscriptions High

All registered FortiGuard
license subscriptions should be

valid.
Renew subscriptions. No

FortiAP Firmware Versions Low All FortiAPs should be running
the latest firmware.

Upgrade FortiAP to
recommended version. No

FortiSwitch Firmware
Versions Low All FortiSwitches should be

running the latest firmware.
Update all FortiSwitches to use

the latest firmware. No

Internal Segmentation Firewall (ISFW)

Goal Severity Check Recommendation Easy
Apply?

Interface Classification High
All interfaces should be
classified as either "LAN",

"WAN", or "DMZ".
Configure the interface role. Yes

Device Discovery High
Interfaces which are classified
as "LAN" or "DMZ" should have
device detection enabled.

Enable device detection. Yes

Third Party Router & NAT
Devices Medium

No third party router or NAT
devices should be detected in

the network.

Replace the device with a
FortiGate. No

VLANManagement Medium
Non-FortiLink interfaces should

not have multiple VLANs
configured on them.

Use FortiSwitch and FortiLink. No
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Goal Severity Check Recommendation Easy
Apply?

Centralized Logging &
Reporting High

Logging and reporting should
be done in a centralized place
throughout the Security Fabric.

Install FortiAnalyzer for logging
& reporting. No

LAN Segment Medium
Servers should be placed

behind interfaces classified as
"DMZ".

All servers should be moved to
interfaces with role "DMZ". No

Unused Policies Medium All IPv4 policies should be
used.

Review all IPv4 policies that
haven't been used in the last

90 days.
No

Advanced Threat
Protection High

Suspicious files should be
submitted to FortiSandbox or

FortiSandbox Cloud for
inspection.

Configure AntiVirus profiles to
send files to FortiSandbox or

FortiSandbox Cloud for
inspection.

No

Unauthorized FortiAPs Medium All discovered FortiAPs should
be authorized or disabled.

Authorize or disable
unauthorized FortiAPs. Yes

Unauthorized
FortiSwitches Medium

All discovered FortiSwitches
should be authorized or

disabled.

Authorize or disable
unauthorized FortiSwitches. Yes

Endpoint Compliance

Goal Severity Check Recommendation Easy
Apply?

Endpoint Registration High
Interfaces which are classified

as "LAN" should have
FortiTelemetry enabled.

Enable FortiTelemetry on
"LAN" interfaces. Yes

FortiClient Protected Medium All supported devices should be
registered via FortiClient.

Register all devices via
FortiClient. No

FortiClient Compliance Medium
All registered FortiClient

devices should be compliant
with FortiClient profile.

Investigate non-compliant
reason(s) for FortiClient

endpoints.
No

FortiClient Vulnerabilities Critical
All registered FortiClient

devices should have no critical
vulnerabilities.

Have FortiClient fix the
detected critical vulnerabilities. No
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Security Best Practices

Goal Severity Check Recommendation Easy
Apply?

Detect Botnet Connections High

Interfaces which are classified
as "WAN" should block or

monitor outgoing connections
to botnet sites

Enable botnet detection on
“WAN” interfaces. Yes

Unsecure Protocol - HTTP High
Interfaces which are classified
as "WAN" should not allow
HTTP administrative access.

Enable HTTPS redirection
globally. Yes

Unsecure Protocol - Telnet High
Interfaces which are classified
as "WAN" should not allow

Telnet administrative access.
Disable Telnet. Yes

Valid HTTPSCertificate -
Administrative GUI Medium

The administrative GUI should
not be using a default built-in

certificate.

Acquire a certificate for your
domain, upload it, and

configure the administrative
GUI to use it.

No

Valid HTTPSCertificate -
SSL VPN Medium SSL VPN should not be using a

default built-in certificate.

Acquire a certificate for your
domain, upload it, and

configure SSL VPN to use it.
No

Explicit Interface Policies Low Policies that allow traffic should
not be using the "any" interface.

Change the policy to use a
specific interface. No

Admin Password Policy Medium
A password policy should be

setup for system
administrators.

Enable a simple password
policy for system
administrators.

Yes

Security Fabric Score

The Security Fabric Scorewidget has been added to the FortiGate Dashboard to give visibility into auditing
trends. This widget uses information from the Security Fabric Audit to determine your score. Score can be
positive or negative, with a higher score representing a more secure network.
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Score is based on the number of checks failed and the severity of these checks. The weight for each severity
level is as follows:

l Critical: 50 points
l High: 25 points
l Medium: 10 points
l Low: 5 points

You get points for passing a test only when it passes for all FortiGates in your fabric. If this occurs, the score is
calculated using this formula:

+Severity Weight x Secure FortiGateMultiplier

The Severity Weight is calculated as Severity divided by the number of FortiGates in the Fabric. The Secure
FortiGate Multiplier is determined using logarithms and the number of FortiGates in the fabric. For example, if
you have four FortiGates in your fabric that all pass the Compatible Firmware check, your score for each
individual FortiGate is:

(50/4) x 1.292 = 16.2 points

If a test fails on any FortiGate in your Fabric, all other FortiGates that passed the check award 0 points. For the
FortiGate the test failed on, the score is calculated using this formula:

-Severity Weight x Count

Count is the number of times the check failed during the audit. For example, if two critical FortiClient
vulnerabilities are discovered during the Audit, your score for that check is:

-50 x 2 = -100 points

For checks that do not apply, your score does not change. For example, if you have no FortiAPs in the fabric, you
will receive no points for the FortiAP Firmware Versions check.

New Dashboard Features
The FortiOS 5.6 Dashboard has a new layout with a Network Operations Center (NOC) view with a focus on
alerts. Widgets are interactive; by clicking or hovering over most widgets, the user can get additional information
or follow links to other pages.

Enhancements to the GUI dashboard and its widgets are:
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l Multiple dashboard support.
l VDOM and global dashboards.
l Updated resize control for widgets.
l Notifications moved to the top header bar (moved existing dashboard notifications to the header and added

additional ones).
l Reorganization of Add Widget dialog.
l NewHost Scan Summarywidget.
l New Vulnerabilities Summarywidget that displays endpoint vulnerability information much like the FortiClient

Enterprise Management Server (EMS) summary.
l Multiple bug fixes.

Features that were only visible through old dashboard widgets have been placed elsewhere in the GUI:

l Restore configuration.
l Configuration revisions.
l Firmware management.
l Enabling / disabling VDOMs.
l Changing inspection mode.
l Changing operation mode.
l Shutdown / restart device.
l Changing hostname.
l Changing system time.

The followingwidgets are displayed by default:

l System Information
l Licenses
l FortiCloud
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l Security Fabric
l Administrators
l CPU
l Memory
l Sessions
l Bandwidth
l Virtual Machine (on VMs and new to FortiOS 5.6.1)

The following optional widgets are available:

l Interface Bandwidth
l Disk Usage
l Security Fabric Risk
l Advanced Threat Protection Statistics
l Log Rate
l Session Rate
l Sensor Information
l HAStatus
l Host Scan Summary
l Vulnerabilities Summary
l FortiView (new to FortiOS 5.6.1)

The following widgets have been removed:

l CLI Console
l Unit Operation
l Alert Message Console

System Information
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FortiGuard WAN IP blacklist service is now online

The Fortiguard WAN IP blacklist service was not online in FortiOS 5.6.0. In FortiOS 5.6.1, a notification appears
on the Dashboard when WAN IP is blacklisted. Clicking on the notification (bell icon) brings up the blacklist
details.

Licenses

Hovering over the Licenseswidget will cause status information (and, where applicable, database information)
on the licenses to be displayed for FortiCare Support, IPS & Application Control, AntiVirus,Web
Filtering, Mobile Malware, and FortiClient. The image below shows FortiCare Support information along
with the registrant's company name and industry.

Clicking in the Licenseswidget will provide you with links to other pages, such asSystem > FortiGuard or
contract renewal pages.
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FortiCloud

This widget displays FortiCloud status and provides a link to activate FortiCloud.

Fortinet Security Fabric

The Security Fabricwidget is documented in the Security Fabric section of theWhat's New document.

Administrators

This widget allows you to view which administrators are logged in and how many sessions are active. The link
directs you to a page displaying active administrator sessions.
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CPU

The real-time CPU usage is displayed for different timeframes.

Memory

Real-time memory usage is displayed for different time frames. Hovering over any point on the graph displays
percentage of memory used along with a timestamp.
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Sessions

Bandwidth
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Virtual Machine

FortiOS 5.6.1 introduces a VM widget with these features:

l License status and type.
l CPU allocation usage.
l License RAM usage.
l VMX license information (if the VM supports VMX).
l If the VM license specifies 'unlimited' the progress bar is blank.
l If the VM is in evaluation mode, it is yellow (warning style) and the dashboard show evaluation days used.

l Widget is shown by default in the dashboard of a FortiOS VM device.
l Removed VM information from License widget at Global > Dashboard.
l License info and Upload License button provided on pageGlobal > System > FortiGuard.
l Updated 'Upload VM License' page:

l Added license RAM usage and VMX instance usage.
l Replaced file input component.

FortiExplorer for iOS
A new iOS FortiExplorer app is available as of April 8, 2017.

FortExplorer for iOS is compatible with iPhone, iPad, and iPod Touch and supports configuration via REST API
and display of FortiView and other security fabric components.

You can use FortiExplorer for iOS to perform most FortiOS configuration management tasks.

Advanced features will be available with the purchase of an add-on through the App Store. These paid features
include the adding more than two devices and downloading firmware images from FortiCare.
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With the release of FortiOS 5.6.1, FortiOS icons and colors are now exportable in the GUI shared project and
FortiExplorer now uses these icons and colors. This change improves the icon colors only for the FortiExplorer
GUI theme (seen only when accessing a web GUI page from within the FortiExplorer iOS app).

The images below offer a preview of a few of the new FortiExplorer iOS app's screens.

FortiExplorer iOS, v 1.0 - Device Status FortiExplorer iOS, v. 1.0 - Sources
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FortiExplorer iOS, v.1.0 - Device Interfaces FortiExplorer iOS, v.1.0 - Firmware

Transparent web proxy (386474)
In addition to the Explicit Web Proxy, FortiOS now supports a Transparent web proxy. While it does not have as
many features as Explicit Web Proxy, the transparent proxy has the advantage that nothing needs to be done on
the user's system to forward supported web traffic over to the proxy. There is no need to reconfigure the browser
or publish a PAC file. Everything is transparent to the end user, hence the name. This makes it easier to
incorporate new users into a proxy deployment.

You can use the transparent proxy to apply web authentication to HTTP traffic accepted by a firewall policy. In
previous versions of FortiOS, web authentication required using the explicit proxy.

Normal FortiOS authentication is IP address based. Users are authenticated according to their IP address and
access is allowed or denied based on this IP address. On networks where authentication based on IP address will
not work you can use the Transparent Web proxy to apply web authentication that is based on the user's browser
and not on their IP address. This authentication method allows you to identify individual users even if multiple
users on your network are connecting to the FortiGate from the same IP address.

Using the Transparent proxy

To implement the Transparent proxy, go to System > Settings and scroll down toOperations Settings and set
the inspection mode to Proxy.
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Then go to System > Feature Visibility and enable Explicit Proxy.

Then go to Security Profiles > Proxy Options, edit a proxy options profile and underWeb Options enable
HTTP Policy Redirect.

Then go to Policy & Objects > IPv4 Policy and create or edit a policy that accepts traffic that you want to
apply web authentication to. This can be a general policy that accepts many different types of traffic as long as it
also accepts the web traffic that you want to apply web authentication to.

Select a Security Profile and select the Proxy Options profile that you enabled HTTP Policy Redirect for.
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Then go to Policy & Objects > Proxy Policy create a Transparent Proxy policy to accept the traffic that you
want to apply web authentication to. Set the Proxy Type to Transparent Web. The incoming interface,
outgoing interface, destination address, and schedule should either match or be a subset of the same options
defined in the IPv4 policy. Addresses added to the Source must match or be a subset of the source addresses
added to the IPv4 policy. You can also add the users to be authenticated by the transparent policy to the source
field.

Select other transparent policy options as required.
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More about the transparent proxy

The following changes are incorporated into Transparent proxy, some of which affect Explicit Web Proxy as well.

Flat policies

The split policy feature has been removed. This will make the explicit policy more like the firewall policy.
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Authentication

The new authentication design is intended to separate authentication from authorization. Authentication has
been moved into a new table in the FortiOS. This leaves the authorization as the domain of the explicit proxy
policy.

Previously, if authentication was to be used:

1. The policy would be classified as an identity based policy
2. The policy would be split to add the authentication parameters
3. The authentication method would be selected
4. The user/group would be configured
Now:

The user/group is configured in the proxy policy

1. A new authentication rule is added
2. This option refers to the authentication scheme
3. The authentication scheme has the details of the authentication method

The new authentication work flow for Transparent Proxy:

Toggle the transparent-http-policy match:

config firewall profile-protocol-options
edit <profile ID>

config http
set http-policy <enable|disable>

If disabled, everything works like before. If enabled, the authentication is triggered differently.

l http-policy work flow:
l For transparent traffic, if there is a regular firewall policy match, when the Layer 7 check option is enabled, traffic

will be redirected to WAD for further processing.
l For redirected traffic, layer 7 policy (HTTP policy) will be used to determine how to do security checks.
l If the last matching factor is down to user ID, then it will trigger a new module to handle the L7 policy user

authentication.
l Then propagate learned user information back to the system so that it can be used to match traffic for L4 policy.

New Proxy Type

There is a new subcategory of proxy in the proxy policy called Transparent Web. The oldWeb Proxy is now
referred to asExplicit Web Proxy.

l This is set in the firewall policy
l It is available when the HTTP policy is enabled in the profile-protocol options for the firewall policy
l This proxy type supports OSI layer 7 address matching.
l This proxy type should include a source address as a parameter
l Limitations:

l It can be used for HTTPS traffic, if deep scanning is not used
l It only supports SNI address matching, i.e. domain names
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l It does not support header types of address matching
l It only supports SSO authentication methods, no active authentication methods.

IP pools support

Proxies are now supported on outgoing IP pools.

SOCKSv5

SOCKSv5 authentication is now supported for explicit proxies.

To configure:

config authentication rule
edit <name of rule>

set protocol socks
end

Forwarding

Proxies support URL redirect/forwarding. This allows a non-proxy forwarding server to be assigned a rule that will
redirect web traffic from one URL to another, such as redirecting traffic destined for youtube.com to
restrict.youtube.com.

l A new option called "Redirect URL" has been added to the policy
l Traffic forwarding by VIP is supported

Support for explicit proxy address objects & groups into IPv4 firewall policies

This would allow the selection of web filter policy, SSL inspection policy, and proxy policy based on source IP +
destination (address|explicit proxy object|category|group of any of those). This enables things like “do full SSL
interception on www.google.com, but not the rest of the Search Engines category”.

Support application service in the proxy based on HTTP requests.

The application service can be configured using the following CLI commands:

config firewall service custom
edit <name of service>
set explicit-proxy enable
set app-service-type <disable|app-id|app-category>
set app-category <application category ID, integer>
set application <application ID, integer>
end

CLI

Changes:

Previous New

config firewall explicit-proxy-policy config firewall proxy-policy
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Previous New

config firewall explicit-proxy-address config firewall proxy-address

config firewall explicit-proxy-addrgrp config firewall proxy-addrgrp

config firewall explicit-proxy-policy
edit <policy ID>

set proxy web
end

config firewall proxy-policy
edit <policy ID>

set proxy explicit-web
end

Removals:

l "split-policy" from firewall explicit-proxy-policy.

The previous method to set up a split policy was:

config firewall explicit-proxy-policy
edit 1

set proxy web
set identity-based enable
config identity-based-policy

edit 1
set schedule "always"
set utm-status enable
set users "guest"
set profile-protocol-options "default"
next

end
next

end

l "auth relative" from firewall explicit-proxy-policy

The following attributes have been removed from firewall explicit-proxy-policy:

l identity-based
l ip-based
l active-auth-method
l sso-auth-method
l require-tfa

Moves:

users and groups from

firewall explicit-proxy-policy identity-based-policy

to

config firewall proxy-policy
edit 1
set groups <Group name>
set users <User name>
end
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Additions:

authentication scheme

config authentication scheme
edit <name>

set method [ntlm|basic|digest|form|negotiate|fsso|rsso|none]

l ntlm - NTLM authentication.
l basic - Basic HTTP authentication.
l digest - Digest HTTP authentication.
l form - Form-based HTTP authentication.
l negotiate - Negotiate authentication.
l fsso - FSSO authentication.
l rsso - RADIUS Single Sign-On authentication.
l none - No authentication.

authentication setting

config authentication setting
set active-auth-scheme <string>
set sso-auth-scheme <string>
set captive-portal <string>
set captive-portal-port <integer value from 1 to 65535>

l active-auth-scheme - Active authentication method.
l sso-auth-scheme - SSO authentication method.
l captive-portal - Captive portal host name.
l captive-portal-port - Captive portal port number.

authentication rule

config authentication rule
edit <name of rule>

set status [enable|disable]
set protocol [http|ftp|socks]
set srcaddr <name of address object>
set srcaddr6 <name of address object>
set ip-based [enable|disable]
set active-auth-method <string>
set sso-auth-method <string>
set web-auth-cookie [enable|disable]
set transaction-based [enable|disable]
set comments

l status - Enable/disable auth rule status.
l protocol - set protocols to be matched
l srcaddr /srcaddr6 - Source address name. [srcaddr or srcaddr6(web proxy only) must be set].
l ip-based - Enable/disable IP-based authentication.
l active-auth-method - Active authentication method.
l sso-auth-method - SSO authentication method (require ip-based enabled)
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l web-auth-cookie - Enable/disable Web authentication cookie.
l transaction-based - Enable/disable transaction based authentication.
l comments - Comment.

NGFW Policy Mode (397035)
You can operate your FortiGate or individual VDOMs in Next Generation Firewall (NGFW) Policy Mode.

You can enable NGFW policy mode by going to System > Settings, setting the Inspection mode to Flow-
based and setting the NGFW mode to Policy-based. When selecting NGFW policy-basedmode you also
select the SSL/SSH Inspection mode that is applied to all policies

Flow-based inspection with profile-based NGFW mode is the default in FortiOS 5.6.

Or use the following CLI command:

config system settings
set inspection-mode flow
set policy-mode {standard | ngfw}

end

NGFW policy mode and NAT

If your FortiGate is operating in NAT mode, rather than enabling source NAT in individual NGFW policies you go
to Policy & Objects > Central SNAT and add source NAT policies that apply to all matching traffic. In many
cases you may only need one SNAT policy for each interface pair. For example, if you allow users on the internal
network (connected to port1) to browse the Internet (connected to port2) you can add a port1 to port2 Central
SNAT policy similar to the following:
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Application control in NGFW policy mode

You configure Application Control simply by adding individual applications to security policies. You can set the
action to accept or deny to allow or block the applications.
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Web Filtering in NGFW mode

You configureWeb Filtering by adding URL categories to security policies. You can set the action to accept or
deny to allow or block the applications.
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Other NGFW policy mode options

You can also combine both application control and web filtering in the same NGFW policy mode policy. Also if the
policy accepts applications or URL categories you can also apply Antivirus, DNS Filtering, and IPS profiles in
NGFW mode policies as well a logging and policy learning mode.

New FortiView Endpoint Vulnerability Scanner chart (378647)
FortiOS 5.6.0 adds a new chart to illustrate Endpoint Control events: Endpoint Vulnerability.
This is a list/bubble chart, that tracks vulnerability events detected by the FortiClients running on all devices
registered with the FortiGate. FortiView displays information about the vulnerability and the device on which it
was detected.
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Notes about the Endpoint Vulnerability Chart:

l You can sort the list byDevice or Vulnerability.
l You can drill down into any device to see the Vulnerabilities detected. From there, you can drill down to see the

exact Vulnerability Scan events that triggered the detection.
l Select any Vulnerability Scan event to see the associated Log data.

FortiClient Profile changes (386267, 375049)

FortiClient profile improvements (386267, 375049)

FortiClient profiles have been changed in FortiOS 5.6 to include new protection features and to change
organization of the GUI options. FortiClient profiles also use the FortiGate to warn or quarantine endpoints that
are not compliant with a FortiClient profile.

A bug that prevented the Dialog and Device Inventory pages from loading when there is a large number of
devices (for example, 10,000) has been fixed.

Default FortiClient profile

FortiClient profiles allow you to perform vulnerability scans on endpoints and make sure endpoints are running
compliant versions of FortiClient. Also, security posture features cause FortiClient to apply realtime protection,
AntiVirus, web filtering, and application control on endpoints.
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The default FortiClient profile also allows you to set a general Non-compliance action for endpoints that don't
have FortiClient installed on them. The non-compliance action can be block or warning and is applied by the
FortiGate. Blocked endpoints are quarantined by the FortiGate.

Endpoint vulnerability scanning

Similar to FortiOS 5.4 you can set the FortiClient Profile to run the FortiClient vulnerability scanner on endpoints
and you can set the Vulnerability quarantine level to quarantine endpoints that don't comply.

The vulnerability scan Non-compliance action can block or warn endpoints if the vulnerability scan shows they
do not meet the vulnerability quarantine level.

System compliance

FortiOS 5.6 system compliance settings are similar to those in 5.4 with the addition of a non-compliance action.
System compliance checking is performed by FortiClient but the non-compliance action is applied by the
FortiGate.
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Security posture checking

Security posture checking collects realtime protection, antivirus protection, web filtering and application firewall
features under the Security Posture Check heading.

Application Control is now standard with FortiCare support
Application Control is now a standard part of any FortiCare support contract and the database for Application
Control signatures is separate from the Intrusion Prevention System (IPS) database. However, botnet application
signatures are still part of the IPS signature database since these are more closely related to security issues than
application detection.

With the release of FortiOS 5.6.1, the Application Control signature database information is displayed under the
System > FortiGuard page, in the FortiCare section. The botnet category is no longer available when you
search for the Application Signatures list.
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To receive updates to the Application Control signature database, you must have a
valid FortiCare support contract.

IPS / Application Control logging performance

There is a major boost to Application Control and IPS when logging is enabled. With the latest changes, the
performance difference with or without logging enabled is negligible.

Real time logging to FortiAnalyzer and FortiCloud
FortiOS 5.6.0 adds new real-time logging options for FortiAnalyzer in System > Security Fabric and for
FortiCloud in Log & Report > Log Settings. The default option is still every 5 minutes, but this will allow near
real-time uploading and consistent high-speed compression and analysis.

For FortiAnalyzer, the CLI syntax to enable real-time is:

config log fortianalyzer setting
set upload-option [realtime/1-minute/5-minute]

For FortiCloud:

config log fortiguard setting
set upload-option [realtime/1-minute/5-minute]

Reliable Logging updated for real-time functionality (378937)

Previously, reliable logging was a feature for buffering and collecting logs for upload, to guarantee that no logs
would be dropped before being passed to logging solutions. Reliable logging has been updated for 5.6.0 so that
real-time logs do not outpace upload speed.

It can be configured in the CLI with:

config log fortianalyzer setting
set reliable [enable/disable]
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FortiGate Logs can be sent to syslog servers in Common Event Format (CEF) (300128)
You can configure FortiOS to send log messages to remote syslog servers in CEF format. CEF is an open log
management standard that provides interoperability of security-related information between different network
devices and applications. CEF data can be collected and aggregated for analysis by enterprise management or
Security Information and Event Management (SIEM) systems such as FortiSIEM.

FortiOS supports logging to up to four remote syslog servers. Each server can now be configured separately to
send log messages in CEF or CSV format. Previously only CSV format was supported.

Use the following command to configure syslog3 to use CEF format:

config log syslog3 setting
set format cef

end

All other syslog settings can be configured as required independently of the log message format including the
server address and transport (UDP or TCP). You can also configure filtering for both CEF and CSV formatted log
messages.

Controlled failover between wireless controllers

1+1 Wireless Controller HA

Instances of failover between FortiAP units was too long and lead to extended periods of time where WiFi users
were without network connection. Because WiFi is considered a primary network connection in today's verticals
(including enterprise, retail, education, warehousing, healthcare, government, and more), it is necessary for
successful failover to occur as fast as possible.

Primary and secondary ACs

You can now define the role of the primary and secondary controllers on the FortiAP unit, allowing the unit to
decide the order in which the FortiAP selects the FortiGate. This process was previously decided on load-based
detection, but can now be defined by each unit's pre-determined priority. In addition, heartbeat intervals have
been lowered to further improve FortiAP awareness and successful failover.

1+1 redundancy

1+1 HA is a form of resilience whereby a component has a backup component to take its place in the event of
component failure, and successfully manage FortiAP without long failover periods.

CLI syntax

config wireless-controller inter-controller
set inter-controller-mode {disable | l2-roaming | 1+1} Default is disable.
set inter-controller-key <password>
set inter-controller-pri {primary | secondary} Default is primary.
set fast-failover-max [3-64] Default is 10.
set fast-failover-wait [10-86400] Default is 10.
config inter-controller-peer

edit <name>
set peer-ip <ip-address>
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set peer-port [1024-49150] Default is 5246.
set peer-priority {primary | secondary} Default is primary.

next
end

end

Multiple PSK for WPA Personal (393320)
New CLI commands have been added, under config wireless-controller vap, to configure multiple
WiFi Protected Access Pre-Shared Keys (WPA-PSKs), as PSK is more secure without all devices having to share
the same PSK.

Note that mpsk-concurrent-clients and the mpsk-key configuration method are only available when
mpsk is set to enable.

CLI syntax

config wireless-controller vap
edit <example>

set mpsk {enable|disable}
set mpsk-concurrent-clients [0-65535] Default is 0.
config mpsk-key

edit <key-name>
set passphrase <wpa-psk>
set concurrent-clients [0-65535] Default is empty.
set comment <comments>

next
end

end

Use the mpsk-concurrent-clients entry to set the maximum number of concurrent connected clients for
each mpsk entry. Use the mpsk-key configuration method to configure multiple mpsk entries.

Hotspot 2.0 (443988) - FortiOS 5.6.3
Multiple new CLI commands have been added, under config wireless-controller, to configure Hotspot
2.0 Access Network Query Protocol (ANQP), a query and response protocol that defines seamless roaming
services offered by an AP.

Syntax

config wireless-controller hotspot20 anqp-3gpp-cellular
edit {name}

config mcc-mnc-list
edit {id}

set id {integer}
set mcc {string}
set mnc {string}

next
next

end

config wireless-controller hotspot20 anqp-ip-address-type
edit {name}

set ipv6-address-type {option}
set ipv4-address-type {option}
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next
end

config wireless-controller hotspot20 anqp-nai-realm
edit {name}

config nai-list
edit {name}

set encoding {enable | disable}
set nai-realm {string}
config eap-method

edit {index}
set index {integer}
set method {option}
config auth-param

edit {index}
set index {integer}
set id {option}
set val {option}

next
next

next
next

end

config wireless-controller hotspot20 anqp-network-auth-type
edit {name}

set auth-type {option}
set url {string}

next
end

config wireless-controller hotspot20 anqp-roaming-consortium
edit {name}

config oi-list
edit {index}

set index {integer}
set oi {string}
set comment {string}

next
next

end

config wireless-controller hotspot20 anqp-venue-name
edit {name}

config value-list
edit {index}

set index {integer}
set lang {string}
set value {string}

next
next

end

config wireless-controller hotspot20 h2qp-conn-capability
edit {name}

set icmp-port {option}
set ftp-port {option}
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set ssh-port {option}
set http-port {option}
set tls-port {option}
set pptp-vpn-port {option}
set voip-tcp-port {option}
set voip-udp-port {option}
set ikev2-port {option}
set ikev2-xx-port {option}
set esp-port {option}

next
end

config wireless-controller hotspot20 h2qp-operator-name
edit {name}

config value-list
edit {index}

set index {integer}
set lang {string}
set value {string}

next
next

end

config wireless-controller hotspot20 h2qp-osu-provider
edit {name}

config friendly-name
edit {index}

set index {integer}
set lang {string}
set friendly-name {string}

next
set server-uri {string}
set osu-method {option}
set osu-nai {string}
config service-description

edit {service-id}
set service-id {integer}
set lang {string}
set service-description {string}

next
set icon {string}

next
end

config wireless-controller hotspot20 h2qp-wan-metric
edit {name}

set link-status {option}
set symmetric-wan-link {option}
set link-at-capacity {enable | disable}
set uplink-speed {integer}
set downlink-speed {integer}
set uplink-load {integer}
set downlink-load {integer}
set load-measurement-duration {integer}

next
end
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config wireless-controller hotspot20 hs-profile
edit {name}

set access-network-type {option}
set access-network-internet {enable | disable}
set access-network-asra {enable | disable}
set access-network-esr {enable | disable}
set access-network-uesa {enable | disable}
set venue-group {option}
set venue-type {option}
set hessid {mac address}
set proxy-arp {enable | disable}
set l2tif {enable | disable}
set pame-bi {enable | disable}
set anqp-domain-id {integer}
set domain-name {string}
set osu-ssid {string}
set gas-comeback-delay {integer}
set gas-fragmentation-limit {integer}
set dgaf {enable | disable}
set deauth-request-timeout {integer}
set wnm-sleep-mode {enable | disable}
set bss-transition {enable | disable}
set venue-name {string}
set roaming-consortium {string}
set nai-realm {string}
set oper-friendly-name {string}
config osu-provider

edit {name}
next

set wan-metrics {string}
set network-auth {string}
set 3gpp-plmn {string}
set conn-cap {string}
set qos-map {string}
set ip-addr-type {string}

next
end

config wireless-controller hotspot20 icon
edit {name}

config icon-list
edit {name}

set lang {string}
set file {string}
set type {option}
set width {integer}
set height {integer}

next
next

end

config wireless-controller hotspot20 qos-map
edit {name}

config dscp-except
edit {index}

set index
set dscp
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set up
next

config dscp-range
edit {index}

set index
set up
set low
set high

next
next

end

VXLAN support (289354)
Virtual Extensible LAN (VXLAN) is a network virtualization technology used in large cloud computing
deployments. It encapsulates OSI layer 2 Ethernet frames within layer 3 IP packets using standard destination
port 4789. VXLAN endpoints that terminate VXLAN tunnels can be virtual or physical switch ports, are known as
VXLAN tunnel endpoints (VTEPs). For more information about VXLAN, see RFC 7348.

VTEP (VXLAN Tunnel End Point) support (289354)

Native VXLAN is now supported by FortiOS. This feature is configurable from the CLI only:

Syntax

config system vxlan
edit <vxlan1> //VXLAN device name (Unique name in system.interface).

set interface //Local outgoing interface.
set vni //VXLAN network ID.
set ip-version //IP version to use for VXLAN device (4 or 6).
set dstport //VXLAN destination port, default is 4789.
set ttl //VXLAN TTL.
set remote-ip //Remote IP address of VXLAN.

next
end

This will create a VXLAN interface:

show system interface vxlan1
config system interface

edit "vxlan1"
set vdom "root"
set type vxlan
set snmp-index 36
set macaddr 8a:ee:1d:5d:ae:53
set interface "port9"

next
end

From the GUI, go to Network > Interfaces to verify the new VXLAN interface:

To diagnose your VXLAN configuration, from the CLI, use the following command:

diagnose sys vxlan fdb list vxlan1
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This command provides information about the VXLAN forwarding data base (fdb) associated to the vxlan1
interface. Below is a sample output:

-----------mac=00:00:00:00:00:00 state=0x0082 flags=0x00-----------
-----------remote_ip=2.2.2.2 remote_port=4789-----------
-----------remote_vni=1 remote_ifindex=19-----------
total fdb num: 1

VXLAN support for multiple remote IPs (398959)

VXLAN is now supported for multiple remote IPs, these remote IPs can be IPv4 unicast, IPv6 unicast, IPv4
multicast, or IPv6 multicast. This is useful in datacenter scenarios where the FortiGate can be configured with
multiple tunnels to computer nodes.

CLI changes

set ip-version option can be set to the following:

ipv4-unicast//Use IPv4 unicast addressing for VXLAN.

ipv6-unicast //Use IPv6 unicast addressing for VXLAN.

ipv4-multicast//Use IPv4 multicast addressing for VXLAN.

ipv6-multicast//Use IPv6 multicast addressing for VXLAN.

When ip-version is set to ipv4-multicast or ipv6-multicast, ttl option is replaced by
multicast-ttl.

New PPPoE features

PPPoE dynamic gateway support (397628)

Original design for PPPoE requires to configure a static gateway. Although it works in many scenarios, some
customers require to add support for dynamic gateway for internet-service based routes.

No changes to the CLI neither to the GUI.

Support multiple PPPoE connections on a single interface (363958)

Multiple PPPoE connections on a single physical or vlan interface are now supported by the FortiGate. In addition
the interface can be on demand PPPoE.
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GUI

CLI

config system pppoe-interace
edit <name>

set dial-on-demand [enable|disable]
set ipv6 [enable|disable]
set device <interface>
set username <string>
set password <string>
set auth-type [auto|pap|chap|mschapv1|mschapv2]
set ipunnumbered <class_ip>
set pppoe-unnumbered-negotiate [enable|disable]
set idle-timeout <integer>
set disc-retry-timeout <integer>
set padt-retry-timeout <integer>
set service-name <string>

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

111



What's New in previous versions of FortiOS 5.6 Chapter 1 - What's New for FortiOS 5.6

set ac-name <string>
set lcp-echo-interval <integer>
set lcp-max-echo-fails <integer>

l dial-on-demand- Enable/disable the dial on demand.feature
l ipv6 - Enable/disable the use of IPv6.
l device - The name of the physical interface.
l username - User name for credentials
l password - Password matching the above username
l auth-type - The type of PPP authentication to be used.

l auto - Automatic choice of authentication
l pap - PAP authentication
l chap - CHAP authentication
l mschapv1 - MS-CHAPv1 authentication
l mschapv2 - MS-CHAPv2 authentication

l ipunnumbered - PPPoE unnumbered IP.
l pppoe-unnumbered-negotiate - Enable/disable PPPoE unnumbered negotiation.
l idle-timeout - Idle time in seconds before PPPoE auto disconnects. 0 (zero) for no timeout.
l disc-retry-timeout - Timeout value in seconds for PPPoE initial discovery. 0 to 4294967295. Default = 1.
l padt-retry-timeout - Timeout value in seconds for PPPoE terminatation. 0 to 4294967295. Default = 1.
l service-name - PPPoE service name.)
l ac-name - PPPoE AC name.
l lcp-echo-interval - Interval in seconds allowed for PPPoE LCP echo. 0 to 4294967295. Default = 5.
l lcp-max-echo-fails - Maximum number of missed LCP echo messages before disconnect. 0 to
4294967295. Default = 3.

Adding Internet services to firewall policies (389951)
In 5.4, support was added for Internet Service objects which could be used with FortiView, Logging, Routing
andWAN Load Balancing. Now they can be added to firewall policies as well.

There is an either or relationship between Internet Service objects and destination
address and service combinations in firewall policies. This means that a destination
address and service can be specified in the policy OR an Internet service, not both.

CLI

The related CLI options/syntax are:

config firewall policy
edit 1

set internet-service 1 5 10
set internet-service-custom test
set internet-service-negate [enable|disable]

end
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GUI

In the policy listing page you will notice that is an Internet Service object is used, it will be found in both the
Destination and Service column.

In the policy editing page the Destination Address, nowDestination field now has two types, Address and
Internet Service.

Combining source and destination NAT in the same policy (388718)
The Service field has been added to Virtual IP objects. When service and portforward are configured, only
a single mapped port can be configured. However, multiple external ports can be mapped to that single internal
port.

config firewall vip
edit "vip1"

set type load-balance
set service "HTTP-8080" "HTTP" <----- New Service field, accepts Service/Service

group names
set extip 20.0.0.0-20.0.255.255
set extintf "wan1"
set portforward enable
set mappedip "30.0.0.1"
set mappedport 100 <-------- single port
end

The reason for making this configuration possible is to allow complex scenarios where multiple sources of traffic
are using multiple services to connect to a single computer, while requiring a combination of source and
destination NAT and not requiring numerous VIPs bundled into VIP groups.

VIPs with different services will considered non-overlapping.
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NP6 Host Protection Engine (HPE) adds protection for DDoS attacks (363398)
NP6 processors now include HPE functionality that can protect networks from DoS attacks by categorizing
incoming packets based on packet rate and processing cost and applying packet shaping to packets that can
cause DoS attacks. You can use the options in the following CLI command to limit the number packets per
second received for various packet types by each NP6 processor. This rate limiting is applied very efficiently
because it is done in hardware by the NP6 processor.

HPE protection is disable by default. You can use the following command to enable HPE protection for the NP6_0
NP6 processor:

config system np6
edit np6_0

config hpe
set enable-shaper enable

end

HPE can be enabled and configured separately for each NP6 processor. When enabled, the default configuration
is designed to provide basic DoS protection. You can use the following command to adjust the HPE settings in
real time if you network is experiencing an attack. For example, the following command allows you to configure
HPE settings for np6_0.

config system np6
edit np6_0

config hpe
set tcpsyn-max
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set tcp-max
set udp-max
set icmp-max
set sctp-max
set esp-max
set ip-frag-max
set ip-others-max
set arp-max
set l2-others-max
set enable-shaper {disable | enable}

end

Where:

tcpsyn-max applies shaping based on the maximum number of TCP SYN packets received per second. The
range is 10,000 to 4,000,000,000 pps. The default limits the number of packets per second to 5,000,000 pps.

tcp-max applies shaping based on the maximum number of TCP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 5,000,000 pps.

udp-max applies shaping based on the maximum number of UDP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 5,000,000 pps.

icmp-max applies shaping based on the maximum number of ICMP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 1,000,000 pps.

sctp-max applies shaping based on the maximum number of SCTP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 100,000 pps.

esp-max NPU HPE shaping based on the maximum number of IPsec ESP packets received. The range is
10,000 to 4,000,000,000 pps. The default is 100,000 pps.

ip-frag-max applies shaping based on the maximum number of fragmented IP packets received. The range is
10,000 to 4,000,000,000 pps. The default is 100,000 pps.

ip-others-max applies shaping based on the maximum number of other IP packets received. The range is
10,000 to 4,000,000,000 pps. The default is 100,000 pps.

arp-max applies shaping based on the maximum number of ARP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 1,000,000 pps.

l2-others-max applies shaping based on the maximum number of other layer 2 packets received. The range
is 10,000 to 4,000,000,000 pps. The default is 100,000 pps.

New feature catalog (5.6.3, 5.6.1 and 5.6)
The following sections list all of the new features in FortiOS 5.6, 5.6.1, and 5.6.3 organized alphabetically by
subject area.

Getting Started (5.6.3)
New Getting Started features added to FortiOS 5.6.3.
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Administrator password changes (414927)

The existing Change Password dialog that appears in the GUI is updated to reflect the new look of the password
change prompt at login.

l Added inline validation for checking password policy and password reuse
l Changed style to match new login prompt password change
l Fixed issue where fDialog would close slide out on submission failure

Support FortiOS to allow user to select domain when logging a FG into FortiCloud (452350)

Support has been added to show a list of all possible FortiCloud domains that the FortiGate can be served by.

Syntax

execute fortiguard-log domain

This command is typically used for testing purposes, and so it will not appear when entering execute
fortiguard-log ?.

Getting Started (5.6.1)
New Getting Started features added to FortiOS 5.6.1.

VM License visibility improvement (423347)

VM License GUI items have changed as follows:

l Added VM widget toGlobal > Dashboard. Includes the following:

l License status and type.
l CPU allocation usage.
l License RAM usage.
l VMX license information (if the VM supports VMX).
l If the VM license specifies 'unlimited' the progress bar is blank.
l If the VM is in evaluation mode, it is yellow (warning style) and the dashboard show evaluation days used.

l Widget is shown by default in the dashboard of a FortiOS VM device.
l Removed VM information from License widget at Global > Dashboard.
l License info and Upload License button provided on pageGlobal > System > FortiGuard.
l Updated 'Upload VM License' page:

l Added license RAM usage and VMX instance usage.
l Replaced file input component.

CLI Syntax

config sys admin
edit <name>

config gui-dashboard
edit <1>

set name <name>
config widget

edit <2>

116 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New in previous versions of FortiOS 5.6

set type {vminfo | ...} <- new option
set x-pos <2>
set y-pos <1>
set width <1>
set height <1>

next
end

next
end

next
end

FortiView Dashboard Widget (434179)

Added a new widget type to the dashboard for top level FortiView. FortiView widgets have report-by, sort-by,
visualization, timeframe properties, and filters subtable in the CLI.

Supported FortiViews include Source, Destination, Application, Country, Interfaces, Policy, Wifi Client, Traffic
Shaper, Endpoint Vulnerability, Cloud User, Threats, VPN, Websites, and Admin and System Events.

Bubble, table, chord chart, and country visualizations are supported in the widget.

Widgets can be saved from a filtered FortiView page on to a dashboard.

Syntax

config system admin
config gui-dashboard

config widget
set type fortiview
set report-by {source | destination | country | intfpair | srcintf | dstintf |

policy | wificlient | shaper | endpoint | application | cloud | web | threat
| system | unauth | admin | vpn}

set timeframe {realtime | 5min | hour | day | week}
set sort-by <string>
set visualization {table | bubble | country | chord}
config filters

set key <filter_key>
set value <filter_value>
end

end
end

end
end

Where:

l report-by = Field to aggregate the data by.
l timeframe = Timeframe period of reported data.
l sort-by = Field to sort the data by.
l visualization = Visualization to use.

Controls added to GUI CLI console (422623)

FortiOS 5.6.1 introduces new options in the browser CLI console to export the console history. Options are now
available to Clear console, Download, and Copy to clipboard.
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FortiExplorer icon enhancement (423838)

FortiOS icons and colors are now exportable in the GUI shared project and FortiExplorer now uses these icons
and colors. This change improves the icon colors only for the FortiExplorer GUI theme (seen only when accessing
a web GUI page from within the FortiExplorer iOS app).

The following locations were affected: Policy List, Policy Dialogue, Address List, Address Dialogue, Virtual IP list,
Virtual IP Dialogue.

Getting Started (5.6)
New Getting Started features added to FortiOS 5.6.

Change to CLI console (396225)

The CLI Console widget has been removed from FortiOS 5.6.0. It is accessed from the upper-right hand corner of
the screen and is no longer a pop-out window but a sliding window.

System Information Dashboard widget WAN IP Information enhancement (401464)

WAN IP and location data are now available in the System Information widget. Additionally, If the WAN IP is
blacklisted in the FortiGuard server, there will be a notification in the notification area, located in the upper right-
hand corner of the Dashboard. Clicking on the notification will open the WAN IP Blacklisted slider with the
relevant blacklist information.

CLI and GUI changes to display FortiCare registration information (395254)

The changes pertain to industry and organization size of the FortiGate's registered owner.

GUI Changes

l Add industry and organization size to FortiCare registration page
l Add company and industry to license widget tooltip for FortiCare

When you hover over the Licenses widget in the FortiOS 5.6 dashboard, you can see the company and industry
data, provided it has been entered in the FortiCare profile.
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CLI Changes

Commands are added to diagnose forticare

dia forticare direct-registration product-registration -h
Options: a:A:y:C:c:T:eF:f:hI:i:l:O:o:p:P:z:R:r:S:s:t:v:

--&lt;long&gt; -&lt;short&gt;
account_id a:
address A:
city y:
company C:
contract_number c:
country_code T:
existing_account e
fax F:
first_name f:
help h
industry I:
industry_id i:
last_name l:
orgsize O:
orgsize_id o:
password p:
phone P:
postal_code z:
reseller R:
reseller_id r:
state S:
state_code s:
title t:
version v:
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Improved GUI for Mobile Screen Size & Touch Interface (355558)

The FortiOS web GUI on mobile screens and include functionality for touch interfaces like tap to hold are
improved.

Setup Wizard removed

Previously, the Setup Wizard could be launched from the web GUI by selecting the button, located in the top
right corner. This button and the wizard in question has been removed.
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Authentication (5.6.3)
New authentication features added to FortiOS 5.6.3.

Certificate Import page updates (267949)

The importation of a non-CA certificate into FortiGate CA store now shows a warning message showing why the
import didn't work (as expected).

Improvements to the execute fortitoken import command (401979)

The execute fortitoken import command has been removed and replaced by three new commands,
allowing the importation of FortiToken seed files from either an FTP server, a TFTP server, or a USB drive:

l execute fortitoken import ftp <file name> <ip>[:ftp port] <Enter> <user>
<password>

l execute fortitoken import tftp <file name> <ip>

l execute fortitoken import usb <file name>

These commands allow seed files to be imported from an external source more easily.

Improved 2FA workflow in GUI (405487, 409100, 444430, 446856, 456752)

Various improvements to the two-factor authentication workflow in the GUI which addressed the following issues:

l No email was sent after creating an administrator account with a FortiToken.
l Inconsistent view on admin and user dialog.
l Empty activation codes would be sent.
l If Norway was selected as the country code for a user, the phone number was not recognized after saving.
l Couldn't select custom SMS server when setting the phone number.
l When a FortiToken from a non-management VDOM was selected for an admin, the activation code wouldn't be

sent.

Support FTM Push when FortiAuthenticator is the authentication server (408273, 438314)

FortiGate supports when the FortiAuthenticator initiates FTM Push notifications, for when users are attempting
to authenticate through a VPN and/or RADIUS (with FortiAuthenticator as the RADIUS server).

Support exact match for subject and CN fields in peer user (416359)

Administrators can now specify which way a peer user authenticates, in order to avoid any unintentional admin
access by a regular user. When searching for a matching certificate, use the commands below to control how to
find matches in the certificate subject name (subject-match) or the cn attribute (cn-match) of the certificate
subject name. This match can be any string (substring) or an exact match (value) of the cn attribute value.

Syntax

config vpn certificate setting
edit <name>

set subject-match {substring | value}
set cn-match {substring | value}

next
end
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FortiToken GUI improvement (435229)

Various FortiToken import functionalities have been improved in the GUI, including the ability to import from
serial number file correctly, validation of serial numbers once imported, and removing the Activate button once a
token has already been activated.

Improve FTM Push notification workflow (436642, 448734)

Updated GUI and logincheck module to use a non-blocking version of the FTM Push notification procedure and
periodically polls the device for any status updates from fam daemon.

FortiClient shares Social ID data with FortiOS (438610)

Support has been added to record the social ID data from FortiClient so that if an email or phone number is
changed on FortiClient, the new values are updated on the FortiGate.

The data will be sent in KeepAlive messages in the following format:

USR_NAME|<full name for the service account>|USR_EMAIL|<email for the service
account>|SERVICE|<os|custom|linkedin|google|salesforce>|

Wildcard certificate support/handling for SAN/CN reference identifiers (440307)

As a requirement of Network Device Collaborative Protection Profile (NDcPP), FortiOS supports and handles the
use of wildcards for the following certificate reference parameters:

l Subject Alternative Name (SAN)
l Common Name (CN)

Support for FTP and TFTP to update certificates (441695)

Support has been added for FTP and TFTP servers to update the certificate bundle using a new execute
command.

Syntax

execute vpn certificate ca import bundle <file-name.pkg> <ftp/tftp-server-ip>

Global option to enable/disable SHA1 algorithm inSSH key exchanges (444827)

Support has been added for a global option top enable/disable SHA1 algorithm in SSH key exchanges. The
algorithm is enabled by default and provides administrators with the ability to disable the option for the purposes
of security and compliance testing.

Syntax

config system global
set ssh-kex-sha1 {enable | disable}

end

Support for HTTP tunnel authentication (449406)

Support has been added for an option to trigger user authentication on HTTPCONNECT request at the policy
level. A new CLI entry has been added under config firewall proxy-policy which will trigger the
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authentication process get-user, even when there is no user or group configured.

Note that, as shown below, explicit web proxy must be set.

Syntax

config firewall proxy-policy
edit {policyid}

set proxy explicit-web
set http-tunnel-auth {enable | disable}

next
end

Authentication (5.6.1)
New authentication features added to FortiOS 5.6.1.

IPv6 RADIUS Support (309235, 402437, 439773)

RADIUS authentication is supported with IPv6, allowing administrators to configure an IPv6 RADIUS server on
the FortiGate for IPv6 RADIUS authentication traffic to pass between the server and FortiGate.

Note that while you can set the primary RADIUS server's IPv6 address, the source IP
address for communications to the RADIUS server cannot be configured as IPv6.

Syntax

Allow IPv6 access on an interface:

config system interface
edit <name>

config ipv6
set ip6-allowaccess {ping | https | ssh | snmp | http | telnet | fgfm | capwap}
set ip6-address <xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx/xxx>

next
next

end

Configure the IPv6 RADIUS server:

config user radius
edit <name>

set server <xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx>
...

next
end

Full certificate chain CRL checking (407988)

Certificate revocation/status check for peer certificates and intermediate CAs is now supported. Redesigned
fnbam_auth_cert() API to use stack type of X509 instead of array for certificate chain. Removed obsolete fnbam
API and parameters. Now authd, sslvpnd, and GUI send full certificate chains to fnbamd for verification.
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New option under user > setting to allow/forbid SSL renegotiation in firewall authentication
(386595)

A new option auth-ssl-allow-renegotiation is now available under config user setting to
allow/forbid renegotiation. The default value is disable, where a session would be terminated by authd once
renegotiation is detected and this login would be recorded as failure. Other behavior follows regular auth settings.

Syntax

config user setting
set auth-ssl-allow-renegotiation {enable | disable}

end

New option to allow spaces in RADIUS DN format (422978)

Previously, IKEv2 RADIUS group authentication introduced a regression because it removed spaces from ASN.1
DN peer identifier string.

Reverted default DN format to include spaces. Added a new CLI option ike-dn-format to allow the user to
select either with-space or no-space. Customers using the group-authentication option can select
the ike-dn-format setting to match the format used in their RADIUS user database.

Added LDAP filter when group-member-check is user-attr (403140)

Added LDAP filter when group-member-check is user-attr. LDAP filter is deployed when checking user
attribute.

Syntax

config user ldap
edit <name>

set group-filter ?
next

end

l group-filter is none by default, where the process is the same as before.
When group-filter is set, the LDAP filter takes effect for retrieving the group information.

Added Refresh button to the LDAP browser (416649)

Previously, cached LDAP data was used even if the LDAP server configuration was updated.

In FortiOS 5.6.1, a Refresh button has been added in the LDAP browser. In the LDAP server dialog page, the
user can delete the DN field to browse the root level tree when clicking the Fetch DN button.

Differentiate DN option for user authentication and membership searching (435791)

Previously, LDAP used the same DN option for user authentication and membership searching. New CLI
commands are introduced to config user ldap to resolve this issue:

l group-member-check user-attr
For user attribute checking, a new attribute group-search-base is added, which indicates the starting point for
the group search. If the group-search-base is not set, binddn is used as the search base. Removed search-
type when group-member-check is user-attr.
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l group-member-check group-object
For group object checking, the group names in user group match rule will be picked up as the group search base. If
there are multiple matching rules, each group name will trigger the ldapsearch query once.

l group-member-check posix-group-object
Changed group-object-search-base to group-search-base for posix-group-object group-
member-check.

FTM Push when FAC is auth server (408273)

This feature adds support for FortiToken Mobile (FTM) push with FortiAuthenticator server in FortiOS. It also
fixes a crash when adding a node to an RB tree, by checking if the same key has already been used in the tree. If
yes, remove the node using the same key before adding a new node.

Non-blocking LDAP authentication (433700)

The previous LDAP authentication in fnbamd used openldap library. OpenLDAP supports non-blocking BIND but
it is not event driven.

To support non-blocking LDAP in fnbamd, we stopped using the openLDAP library in fnbamd, instead using only
liblber. Instead of using openLDAP, fnbamd will create its own event-driven connection with LDAP servers over
LDAP/LDAPS/STARTTLS, make it non-blocking, do CRL checking if necessary, and compose all LDAP requests
using liblber (including bind, unbind, search, password renewal, password query, send request and receive
response, and parse response). The whole process is done in one connection.

This doesn't change any openLDAP implementation but moves some data structure definitions and API
definitions from some internal header files to public header files.

Manual certificate SCEP renewal (423997)

Added support of manual certificate SCEP renewal besides the auto-regeneration feature that already exists.

More detailed RADIUS responses shown in connectivity test (434303)

Improved on-demand test connectivity for RADIUS servers. Test results show RADIUS server reachability, NAS
client rejection, and invalid User/Password. Test also shows RADIUS Attributes returned from the RADIUS
server.

Example

FG100D3G12807101 # diagnose test authserver radius-direct
<server_name or IP> <port no(0 default port)> <secret> <user> <password>

FG100D3G12807101 # diagnose test authserver radius-direct 1.1.1.1 0 dd
RADIUS server '1.1.1.1' status is Server unreachable

FG100D3G12807101 # diagnose test authserver radius-direct 172.18.5.28 0 dd
RADIUS server '172.18.5.28' status is Secret invalid

FG100D3G12807101 # diagnose test authserver radius-direct 172.18.5.28 0 fortinet jeff1
asdfasdf

RADIUS server '172.18.5.28' status is OK
Access-Reject

FG100D3G12807101 # diagnose test authserver radius-direct 172.18.5.28 0 fortinet ychen1
asdfasdf
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RADIUS server '172.18.5.28' status is OK
Access-Accept
AVP: l=6 t=Framed-Protocol(7)

Value: 1
AVP: l=6 t=Service-Type(6)

Value: 2
AVP: l=46 t=Class(25)

Value: 9e 2a 08 6d 00 00 01 37 00 01 17 00 fe 80 00 00 00 00 00 00 00 00 5e fe ac 12 05
1c 01 d2 cd b6 75 a6 80 56 00 00 00 00 00 00 00 1c

AVP: l=12 t=Vendor-Specific(26) v=Microsoft(311)
VSA: l=6 t=MS-Link-Utilization-Threshold(14)
Value: 50

AVP: l=12 t=Vendor-Specific(26) v=Microsoft(311)
VSA: l=6 t=MS-Link-Drop-Time-Limit(15)
Value: 120

User group authentication timeout range increased to 30 days (378085)

You can now use the following command to override the default user authentication timeout for users in a user
group to up to 30 days.

config user group
edit <group-name>

set authtimeout 43200
end

Where authtimeout is the length of the timeout in minutes. An authtimeout of 43200 minutes is equivalent
to 30 days. Set authtimeout to 0 to use the default authentication timeout.

Authentication (5.6)
New authentication features added to FortiOS 5.6.

FortiToken Mobile Push (397912, 408273, 399839, 404872)

FortiToken Mobile push supports two-factor authentication without requiring users to enter a four-digit code to
authenticate. Instead they can just accept the authentication request from their FortiToken Mobile app.

A new command has been added under config system ftm-push allowing you to configure the FortiToken
Mobile Push services server IP address and port number. The Push service is provided by Apple (APNS) and
Google (GCM) for iPhone and Android smartphones respectively. This will help to avoid tokens becoming locked
after an already enabled two-factor authentication user has been disabled.

CLI syntax

config system ftm-push
set server-ip <ip-address>
set server-port [1-65535] Default is 4433.

end

If an SSL VPN user authenticates with their token, then logs out and attempts to reauthenticate again within a
minute, a new message will display showing "Please wait x seconds to login again." This replaces a previous
error/permission denied message.

The "x" value will depend on the calculation of how much time is left in the current time step.
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CLI syntax

config system interface
edit <name>

set allowaccess ftm
next

end

Support V4 BIOS certificate (392960)

FortiOS now supports backwards compatibility between new BIOS version 4 and old BIOS version 3.

New BIOS V4 certificates:

l Fortinet_CA
l Fortinet_Sub_CA
l Fortinet_Factory

Old BIOS V3 certificates:

l Fortinet_CA_Backup
l Fortinet_Factory_Backup

When FortiOS connects to FortiGuard, FortiCloud, FortiManager, FortiAnalyzer, FortiSandbox as a client, the
new BIOS certificate Fortinet_Factorywill be the default client certificate. When the server returns its certificate
(chain) back, FortiOS looks up the issuer of the server certificate and either keeps client certificate as is or
switches to the old BIOS certificate Fortinet_Factory_Backup. This process occurs in one handshake.

When FortiOS connects to FortiCare, the new BIOS certificate Fortinet_Factory is the only client certificate and
Server Name Indication (SNI) is set. There is no switchover of certificate during SSL handshake.

When FortiOS acts as a server when connected by FortiExtender, FortiSwitch, FortiAP, etc., Fortinet_Factory is
the default server certificate. FortiOS detects SNI in client hello, and if no SNI is found or if the CN in SNI is
different from the CN of Fortinet_CA, it switches to use the old Fortinet_Factory_Backup.

Support extendedKeyUsage for x.509 certificates (390393)

As per Network Device Collaborative Protection Profile (NDcPP) v1.0 requirements, server certificates used for
TLS connections between FortiGate and FortiAnalyzer should have the "Server Authentication" and "Client
Authentication" extendedKeyUsage fields in FIPS/CC mode.

To implement this, a new CLI command has been added under log fortianalyzer setting to allow you
to specify the certificate used to communicate with FortiAnalyzer.

CLI syntax

config log fortianalyzer setting
set certificate <name>

end
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Administrator name added to system event log (386395)

The administrator's name now appears in the system event log when the admin issues a user quarantine ban on a
source address.

Support RSA-4096 bit key-length generation (380278)

In anticipation of quantum computers, RSA-4096 bit key-length CSRs can now be imported.

New commands added to config user ldap to set UPN processing method and filter name
(383561)

Added two new commands to config user ldap allowing you to keep or strip domain string of UPN in the
token as well as the search name for this kind of UPN.

CLI syntax:

config user ldap
set account-key-processing
set account-key-name

end

User authentication max timeout setting change (378085)

To accommodate wireless hotspot users authenticated on the FortiGate, the user authentication max timeout
setting has been extended to three days (from one day, previously).

Changes to Authentication Settings > Certificates GUI (374980)

Added new icons for certificate types and updated formatters to use these new icons.

Password for private key configurable in both GUI and CLI (374593)

FortiOS 5.4.1 introduced a feature that allowed you to export a local certificate and its private key in password
protected p12, and later import them to any device. This option to set password for private key was available only
in the CLI (when requesting a new certificate via SCEP or generating a CSR). This feature is now also
configurable through the GUI.

The new Password for private key option is available under System > Certificateswhen generating a new
CSR.

RADIUS password encoding (365145)

A new CLI command, under config user radius, has been added to allow you to configure
RADIUS password encoding to use ISO-8859-1 (as per RFC 2865).

Certain RADIUS servers use ISO-8859-1 password encoding instead of others such as UTF-8. In these instances,
the server will fail to authenticate the user, if the user's password is using UTF-8.

CLI syntax

config user radius
edit <example>

set password-encoding <auto | ISO-8859-1>
end
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This option will be skipped if the auth-type is neither auto nor pap.

RSSO supports Delegated-IPv6-Prefix and Framed-IPv6-Prefix (290990)

Two attributes, Delegated-IPv6-Prefix and Framed-IPv6-Prefix, have been introduced for RSSO to provide a
/56 prefix for DSL customers. All devices connected from the same location (/56 per subscriber) can be mapped
to the same profile without the need to create multiple /64 or smaller entries.

FortiOS Carrier (5.6.3)
New FortiOS Carrier features added to FortiOS 5.6.3.

Improved CLI attribute name under 'gtp.message-filter-v0v1' (452813)

CLI "gtp.message-filter-v0v1" had an attribute "create-aa-pdp|init-pdp-ctx", which contains a
vertical pipe |. The attribute name was changed to "v0-create-aa-pdp--v1-init-pdp-ctx".

Its help text is also changed to avoid the vertical bar.

Syntax

config gtp message-filter-v0v1
edit <name>

set ?
......
v0-create-aa-pdp--v1-init-pdp-ctx

Improved GTP performance (423332)

There are independent Receive and Transmit queues for gtp-u process. These queues are and their associated
resources are initialized when the ftp-enhance-mode is enabled.

CLI changes under system npu

gtp-enhance-mode

config system npu
set gtp-enhance-mode [enable|disable]
end

This configuration requires a reboot of the device to initialize the changes.

gtp-enhance-cpu-range

This is used to set the CPUs which can process the GTP-U packet inspection.

config system npu
set gtp-enhance-cpu-range [0|1|2]
end
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Option Description

0 Inspect GTPU packets by all CPUs

1 Inspect GTPU packets by Master CPUs

2 Inspect GTPU packets by Slave CPUs

New diagnose commands

diagnose npu np6 hbq-stats [all|np xx]
Used to see the GTP-U packet counter by all NP or the corresponding np.

diagnose npu np6 hbq-stats-clear all /np xx

Used to clear the GTP-U packet counter by all NP or the corresponding np.

Verifying the enhance-mode is disabled

Before execute the test or enable/disable the gtp enhance, first check the gtp-enhance-mode status as in the
example below:

config system npu
get
gtp-enhance-mode: disable
gtp-enhance-cpu-range: 0
end

If the gtp-enhance-mode is disable, use the command diagnose npu np6 hbq-stats all.

The output will be similar to below:

# diagnose npu np6 hbq-stats all
Total :0

If the gtp-enhance-mode is enable, use the command diagnose npu np6 hbq-stats all

The output will be similar to below:

# diagnose npu np6 hbq-stats all
cpu_ 0:0
cpu_ 1:0
cpu_ 2:0
cpu_ 3:0
cpu_ 4:0
cpu_ 5:0
cpu_ 6:0
cpu_ 7:0
cpu_ 8:0
cpu_ 9:0
cpu_10:0
cpu_11:0
cpu_12:0
cpu_13:0
cpu_14:0
cpu_15:0
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cpu_16:0
cpu_17:0
cpu_18:0
cpu_19:0
cpu_20:0
cpu_21:0
cpu_22:0
cpu_23:0
cpu_24:0
cpu_25:0
cpu_26:0
cpu_27:0
cpu_28:0
cpu_29:0
cpu_30:0
cpu_31:0
cpu_32:0
cpu_33:0
cpu_34:0
cpu_35:0
cpu_36:0
cpu_37:0
cpu_38:0
cpu_39:0
Total :0

Sometimes, when loading the new configure file, and the new configure file does not match the old configure file,

the gtp-enhance-mode status will be confused.

You can see :

#config system npu
#get
gtp-enhance-mode: enable

but you can also see that

diagnose npu np6 hbq-stats all
Total :0

This means the gtp-enhance-mode is actually set to disable.

The inverse is also possible, when you see

#config system npu
#get
gtp-enhance-mode: disable

but you also see that

# diagnose npu np6 hbq-stats all
cpu_ 0:0
...
cpu_39:0
Total :0

This means the gtp-enhance-mode is actually set to enable.
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If these combinations occur, just run the command below:

config system npu
set gtp-enhance-mode enable
end

or

config system npu
set gtp-enhance-mode disable
end

Once this is done,reboot the device to let the 2 statuses match.

FortiOS Carrier (5.6.1)
New FortiOS Carrier features added to FortiOS 5.6.1.

GTP enhancement and GTP Performance Improvement. (423332)

The GTP changes in 5.6.1 take place in the following categories:

New GTP features and functionality enhancements.

l GTPmessage filter enhancements, including:
l Unknown message white list
l GTPv1 and GTPv2 profile separation
l Message adoption.

l GTP IE white list.
l Global APN rate limit, including:

l sending back REJECT message with back-off timer
l "APN congestion" cause value

l GTP half-open, half-close configurable timer.

GTP performance improvements.

l Implemented RCU on GTP-U running path. i.e, no locking needed to look up tunnel state when processing GTP-U.

Note the RCU is only applied on GTPv1 and GTPv2 tunnels. It is not used for GTPv0 tunnels, due to the fact
that (1) GTPv0 traffic is relatively minor compared with GTPv1 and GTPv2, and (2) GTPv0 tunnel indexing is
totally different from GTPv1 and GTPv2. GTPv0 tunnel is indexed by [IMSI, NSAPI]. GTPv1 and GTPv2 tunnel
is indexed by [IP, TEID]

l Localized CPUmemory usage on GTP-U running path.

l GTP-C: changed some GTP tables from RB tree to hash table, including
l GTP request tables, and GTPv0 tunnel tables.
l Testing showed, when handling millions of entries adding/deleting, hash table performance was much better.
l 2.3.2 Hash table is compatible with RCU API, so we can apply RCU on these GTP-C tables later for further

performance improvements.

l GTP-C, improved GTP path management logic, so that GTP path will time out sooner when there are no tunnels
linked to it
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CLI Changes:

New Diagnose commands:

diagnose firewall gtp

Option Description

hash-stat-tunnel GTP tunnel hash statistics.

hash-stat-v0tunnel GTPv0 tunnel hash statistics.

hash-stat-path GTP path hash statistics.

hash-stat-req GTP request hash statistics.

vd-apn-shaper APN shaper on VDOM level.

ie-white-list-v0v1 IE white list for GTPv0 or v1.

ie-white-list-v2 IE white list for GTPv2.

diagnose firewall gtp vd-apn-shaper

Option Description

list List

diagnose firewall gtp ie-white-list-v0v1

Option Description

list List

diagnose firewall gtp ie-white-list-v2

Option Description

list List

config gtp apn-shaperapn-shaper
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Option Description

apn APN to match. Leave empty to match ANY.

"apn" field can be empty, it matches
ANY apn. when configured, it is used to
set a limit for any apn which is not
explicitly listed; Also, if configured, such
an entry should be the last entry, as it is
first-match rule.

rate-limit Rate limit in packets/s (0 - 1000000, 0 means
unlimited).

action Action. [drop | reject]

There is no back-off timer in GTPv0,
therefor the reject action is not
available for V0

back-off-time Back off time in seconds (10 - 360).

back-off-time visible when action is
"reject"

Changed commands:

Under command firewall gtp, config message-filter is replaced by set message-filter-
v0v1

Example:
config firewall gtp

edit <name>
set message-filter-v0v1

New fields have been added to the config firewall gtp command context

Option Description

half-open-timeout Half-open tunnel timeout (in seconds).

half-close-timeout Half-close tunnel timeout (in seconds).

Example:
config firewall gtp

edit <name>
set half-open-timeout 10
set half-close-timeout 10
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Models affected by change

l FortiGate 3700D
l FortiGate 3700DX
l FortiGate 3800D
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Device identification (5.6)
New Device Identification features added to FortiOS 5.6.

Changed default for device-identification-active-scan to disabled (380837)

It was decided that most customers would not appreciate a default setting that resulted in the FortiGate probing
their systems, so active scan option is changed to disabled by default going forward, but upgrade code is added
to keep the option enabled for those upgrading from 5.4.0 or 5.4.1 who were using device-identification with
active scan enabled.
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Diagnose command changes (5.6.1)
New diagnose features added to FortiOS 5.6.1.

crash dump improvement on i386/X86_64 (396580)

The output from the WPAD crash dump can now be in binary format as well as hexidecimal. The two commands
are:

1. For dump in binary format
diagnose debug app wpad-dump <debug_level>

2. For dump in hexidecimal format
diagnose debug app wpad-crash-hexdump <debug_level>

LLDP diagnose commands easier to execute (413102)

While there is no change to the syntax of the commands, the LLDP diagnose commands are allowed to execute
without switchid/portid parameters configured.

New command to monitor IPS stats (414496)

When WAD IPS scanning took place with a failed result, the message caused the IPS sensor to mistakenly record
the event as something triggering the sensor. To correct this, a new command was created.

Command:

diagnose wad stats ips [list | clear ]

list List IPS statistics

clear Clear IPS statistics

Example

diagnose wad stats ips list
IPS status
unix stream counter = 0
active sess counter = 0
ips provider counter = 0
not running failure = 0
all busy failure = 0
conn close counter = 0
conn connected counter = 0
conn failure = 0
zero len failure = 0
suspended failure = 0
push failure = 0
block write counter = 0
un-block write counter = 0
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un-matching failure = 0
ips action failure = 0
ips action permit = 0
ips action deny = 0
ips action bypass = 0

Additional information in FortiGate 30E model diagnose command (422266)

Due to additional modem features being merged into the FortiGate 30E firmware, there is more status
information displayed when using the diagnose sys lte-modem command. There are also additional
related MIB options.

New diagnose sys fips kat-error options (440186)

The command diagnose sys fips kat-error has added additional options, like ECDSA.

Diagnose command changes (5.6)
New diagnose features added to FortiOS 5.6.

Add missing "diag npu np6 ..." Commands (305808)

The following diag npc np6 commands have been reintroduced into 5.6.0.

These options were available in 5.2.x but were not in 5.4.0

l diag npc np6 gmac-stats - Shows the GMACMIBs counters
l diag npc np6 gmac-stats-clear - Clears the GMACMIBS counters
l diag npc np6 gige-port-stats - Shows the GIGE PORT MIBs counters
l diag npc np6 gige-port-stats-clear - Clears the GIGE PORT MIBs counters

Diagnose command to show firewall service cache (355819)

A diagnostic command has been added to dump out the service name cache kept by the miglogd daemon for
each individual VDOM.

diag test app miglogd 106

Example output:

This output has been edited down to conserve space. Only the first 5 of each grouping has been included.

diag test app miglogd 106
tcp
port(0), name(NONE)
port(21), name(FTP)
port(22), name(SSH)
port(23), name(TELNET)
port(25), name(SMTP)
udp
port(53), name(DNS)
port(67--68), name(DHCP)
port(69), name(TFTP)
port(88), name(KERBEROS)
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port(111), name(ONC-RPC) extra: (ONC-RPC) (NFS)
icmp
port(1), name(test)
port(8), name(PING)
port(13), name(TIMESTAMP)
port(15), name(INFO_REQUEST)
port(17), name(INFO_ADDRESS)
general
prot(6), port(4300), name(example.com_Webadmin)
prot(6), port(5060), name(SIP)
prot(6), port(5190--5194), name(AOL)
prot(6), port(5631), name(PC-Anywhere)
prot(6), port(5900), name(VNC)
service names:
WINFRAME,DNS,DCE-RPC,H323,RLOGIN,IRC,UUCP,example.com_Webadmin,HTTPS,WAIS,FINGER,REXEC,
RAUDIO,SNMP,TIMESTAMP,RADIUS-OLD,DHCP,AOL,MGCP,SMTPS,INFO_REQUEST,HTTP,SCCP,SOCKS,PPTP,
ONC-RPC,NNTP,SMTP,QUAKE,PC-Anywhere,TFTP,NONE,SSH,RSH,IMAPS,LDAP_UDP,SIP,RIP,PING,PING6,
X-WINDOWS,SMB,SAMBA,TRACEROUTE,NFS,WINS,L2TP,IMAP,GOPHER,SIP-MSNmessenger,SYSLOG,DHCP6,
TELNET,LDAP,MS-SQL,MMS,KERBEROS,SQUID,NTP,FTP,CVSPSERVER,test,AFS3,POP3,Internet-Locator-

Service,
service groups:
Email Access(DNS,IMAP,IMAPS,POP3,POP3S,SMTP,SMTPS,)
Windows AD(DCE-RPC,DNS,KERBEROS,LDAP,LDAP_UDP,SAMBA,SMB,)
Web Access(DNS,HTTP,HTTPS,)
Exchange Server(DCE-RPC,DNS,HTTPS,)
policies involving multiple service definitions:

Diagnose command to show crash history and adjust crash interval (366691)

In order to alleviate the impact logging put on resources if processes repeatedly crash, limits have been put on
crash logs.

l The default limit is 10 times per 60 minutes for crash logs. This limit can be edited using the command:

diagnose debug crashlog interval <interval>

<interval> is the number of second to log crash logs for a particular process

l The miglogd daemon is the only one to write crash logs directly. Crash logs from other processes are done
through miglogd.

l Crash logs for a single crash are written all at once so that the logs are easier to read if there are crashes of multiple
processes at the same time.

l A diagnose command has been added to show crash history.

# diagnose debug crashlog history
# Crash log interval is 3600 seconds
# reportd crashed 2 times. The latest crash was at 2016-12-01 17:53:45

diagnose switch-controller commands (368197)

The following diagnose commands in the CLI, are designed to

l Output stats on the managed switches
l Kick the client from the managed switches

diagnose switch-controller dump lldp neighbors-summary <device-id> <portid>

diagnose switch-controller dump lldp neighbors-detail <device-id> <portid>
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diagnose switch-controller dump lldp Stats <device-id>

diagnose switch-controller dump port-stats <device-id>

diagnose switch-controller dump trunk-state <device-id>

diagnose switch-controller kick <device-id> <vlan ID> <port ID> <MAC ID>

While not a diagnostic command, the following can also be run from VDOMs

execute replace-device fortiswitch <device-id>

These commands are now longer restricted to being run from the root VLAN and can be run from any VDOM

Diagnose commands for monitoring NAT sessions (376546)

We have developed the following monitoring capabilities in CLI and SNMP.

l NAT sessions per IP pool
l Total tcp sessions per IP pool
l Total udp sessions per IP pool
l Total others (non-tcp and non-udp) sessions per IP pool

FortiGate supports 4 types of NAT, which are

l Overload
l One-to-one
l Fixed-port-range
l Port-block-allocation.

diagnose firewall ippool-all

l list - lists all of the IP Pools
l stats - Statistics of the IP Pools

list

diagnose firewall ippool-all list

Example output:

vdom:root owns 4 ippool(s)
name:Client-IPPool
type:port-block-allocation
nat-ip-range:10.23.75.5-10.23.75.200
name:Fixed Port Range
type:fixed-port-range
nat-ip-range:20.20.20.5-20.20.20.50
name:One to One
type:one-to-one
nat-ip-range:10.10.10.5-10.10.10.50
name:Sales_Team
type:overload
nat-ip-range:10.23.56.18-10.23.56.20
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Stats

This option has two methods of being used. By just hitting enter after stats, the output contains the stats for all of
the IP Pools. By putting the name of an IP Pool after stats, the output is filtered so that only stats relating to that
particular IP Pool is included in the output.

Example output #1

# diagnose firewall ippool-all stats
vdom:root owns 5 ippool(s)
name: Client-IPPool
type: port-block-allocation
startip: 10.23.75.5
endip: 10.23.75.200
total ses: 0
tcp ses: 0
udp ses: 0
other ses: 0
name: Fixed Port Range
type: fixed-port-range
startip: 20.20.20.5
endip: 20.20.20.50
total ses: 0
tcp ses: 0
udp ses: 0
other ses: 0
name: One to One
type: one-to-one
startip: 10.10.10.5
endip: 10.10.10.50
total ses: 0
tcp ses: 0
udp ses: 0
other ses: 0
name: Sales_Team
type: overload
startip: 10.23.56.18
endip: 10.23.56.20
total ses: 0
tcp ses: 0
udp ses: 0
other ses: 0

Example #2

# diagnose firewall ippool-all stats “Sales_Team”
name: Sales_Team
type: overload
startip: 10.23.56.18
endip: 10.23.56.20
total ses: 0
tcp ses: 0
udp ses: 0
other ses: 0
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SIP diagnose command improvements (376853)

A diagnose command has been added to the CLI that outputs VDOM data located in the voipd daemon.

diagnose sys sip-proxy vdom

Example

(global) # diagnose sys sip-proxy vdom
VDOM list by id:
vdom 0 root (Kernel: root)
vdom 1 dmgmt-vdom (Kernel: dmgmt-vdom)
vdom 2 test2 (Kernel: test2)
vdom 3 test3 (Kernel: test3)
vdom 4 vdoma2 (Kernel: vdoma2)
vdom 5 vdomb2 (Kernel: vdomb2)
vdom 6 vdomc2 (Kernel: vdomc2)
vdom 7 vdoma (Kernel: vdoma)
vdom 8 vdomb (Kernel: vdomb)
vdom 9 vdomc (Kernel: vdomc)
VDOM list by name:
vdom 1 dmgmt-vdom (Kernel: dmgmt-vdom)
vdom 0 root (Kernel: root)
vdom 2 test2 (Kernel: test2)
vdom 3 test3 (Kernel: test3)
vdom 7 vdoma (Kernel: vdoma)
vdom 4 vdoma2 (Kernel: vdoma2)
vdom 8 vdomb (Kernel: vdomb)
vdom 5 vdomb2 (Kernel: vdomb2)
vdom 9 vdomc (Kernel: vdomc)
vdom 6 vdomc2 (Kernel: vdomc2)

Diagnose command to get AV virus statistics (378870)

A new diagnostic command has been added for the showing of AV statistics. This can be used within each VDOM

Syntax:

diagnose ips av stats show

Example output

diagnose ips av stats show
AV stats:
HTTP virus detected: 0
HTTP virus blocked: 0
SMTP virus detected: 0
SMTP virus blocked: 0
POP3 virus detected: 0
POP3 virus blocked: 0
IMAP virus detected: 0
IMAP virus blocked: 0
NNTP virus detected: 0
NNTP virus blocked: 0
FTP virus detected: 0
FTP virus blocked: 0
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SMB virus detected: 0
SMB virus blocked: 0

Diagnose command to get remote FortiSwitch trunk information (379329)

To ensure that a FortiGate and its managed FortiSwitches stay in synchronization in the event of an inadvertent
trunk table change situation, there is a new CLI setting that checks for discrepancies.

The idea is to check to see if there will be a synchronization issue between the FortiGate and the FortiSwitch
before applying the configuration

1. On fortilink reconnection, FGT reads trunk table of FSW using REST API GET-- Hence FGT gets all the port and
its trunk membership information from FSW

2. FGT then compares its managed FSW trunk information with received FSW information
3. If there is any conflict, FGT will delete extra/conflicted trunk on FSW using REST API POST
4. At the end FGT replays all configuration to FSW as usual
This will help delete the extra trunks, conflicted trunks on the FSW and to make sure in sync

Possible reasons for losing synchronization include:

l The FortiGate reboots after a factory reset while there is still a trunk configuration in the FortiSwitch.
l The managed FortiSwitch's trunk table gets edited on the FortiGate while the FortiSwitch is offline.
l A trunk table on the FortiSwitch gets added or the existing one gets modified or deleted by a user.

New diagnose command for the CLI:

diagnose switch-controller dump trunk-switch-config <Managed FortiSwitch device ID>

help provided for diagnose debug application csfd (379675)

The syntax for the command is:

diagnose debug application csfd <Integer>

The <Integer> being the debug level. To get the integer value for the debug level, run the command without the
integer. You will get the following:

# diagnose debug application csfd
csfd debug level is 0 (0x0)
Error 0x01
Warning 0x02
Function trace 0x04
Information 0x08
Detail 0x10
MAC packet encryption debug 0x20
MAC learning debug 0x40
FAZ configuration synchronize debugging 0x0080
FAZ configuration function trace 0x00100
Configuration tree update debug 0x00200
Configuration tree function trace 0x00400
HA Sync plugin debug 0x00800

Convert the value next to the debug level you want to an integer. For example, to set the debug level to
Information, convert 0x08 to 8 and use it for the option at the end of the command.

# diagnose debug application csfd 8
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New IPS engine diagnose commands (381371)

Periodically, when troubleshooting, an different IPS engine will need to be installed on the FortiGate but there will
also be a restriction that the FortiGate can't be rebooted. Normally, a new IPS engine will not be fully recognized
by the system until after a reboot. This command allows the running of new commands or new versions of
commands in the IPS engine without having to reboot the FortiGate.

diagnose ips test cmd <command strings>

The command strings are separated by a semicolon such as:

diagnose ips test cmd command1;command2;command3

Examples:

l diagnose ips test cmd "ips session status"

This command triggers the diagnosis command in the double quotation marks: "diagnose ips session
status"

l diag ips test cmd "ips memory track; ips memory status; ips session status"

This command triggers the diagnosis commands in the double quotation marks in order.

The results:

Commands[0]: ips memory track
----< execute "diagnose ips memory track" >----
Commands[1]: ips memory status
----< execute "diagnose ips memory status" >----
Commands[2]: ips session status
----< execute "diagnose ips session status" >----

New AV engine diagnose commands (383352)

The purpose of this diagnostic command is to display information from within the AV engine for the purposes of
aiding trouble shooting and diagnostics if the AV engine crashes or times out.

The command is:

diagnose antivirus test

It's syntax can be one of the following:

diagnose antivirus test <command>
diagnose antivirus test <command argument1>; <argument2>; ...

The command is defined and interpreted by the AV engine. FortiOS just passes the CLI

command into the AV engine and outputs the strings returned by AV engine.

In AV engine 5.4.239, the following command are supported.

l get scantypes

l set scantypes

l debug

144 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New in previous versions of FortiOS 5.6

NPU diagnose command now included HPE info in results (384692)

There is no change to the CLI but the results of the diagnose npu np6 npu-feature command now
include results regarding HPE.

clear checksum log files (diag sys ha checksum log clear) (385905)

There is currently a command, diag sys ha checksum log [enable | disable] that enables a
checksum debug log by saving checksum calculations to a temp file. However, the checksum calculations saved
in this file can be processed by two different functions, cmdbsvr and the CLI.

The function cmf_context-is-server() now enables the determining whether the running process is
cmdbsvr or the CLI and also a diagnose command has been added to clear the contents of the file.

diag sys ha checksum log clear

new diagnose command to delete avatars (388634)

It is now possible to delete avatars associated with FortiClient clients.

diagnose endpoint avatar delete <FortiClient UID>

or

diagnose endpoint avatar delete <FortiClient UID> <username>

l If only the FortiClient UID is used, all of the avatars, except those that are currently being used will be deleted.
l If both the FortiClient UID and the username are used, all of the avatars that belong to that combination, except

those being used, will be deleted.

CID signatures have been improved for DHCP and CDP (389350, 409436)

More parameters have been added to make them more specific. This helps to reduce false positives.

l DHCP signatures:

l A new dhcp signature file has been added 'cid.dhcp2' that allows for the class and host name to specified in the
same signature. This is for increased accuracy.

l Relevant signatures from 'cid.dhcp' have been ported to the new signature file 'cid.dhcp2'
l Support DHCP parameter matching in signatures.
l Support DHCP option list matching in signatures.

l CDPmac analyzer now passes all three keys to the OSmatcher.

l Tests:
l A number of new tests (including pcaps) have been added to match existing signatures and new signatures.
l Some tests where multiple protocols were present in a single pcap, have been modified. These are now split

into multiple pcaps, each containing a single protocol. This allows FortiOS to fully test a signature, where
previously a single test may have matched multiple signatures.

l CID debug statistics now use shared memory. This prevents the daemon from having to respond to CLI requests
and allows for the stats to persist across daemon restarts.
l AChange has been made to the host ip update priority. IP changes for routers that have had their type set by

heuristic are not allowed to change IPs.
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l If it is a Fortinet device, the change is allowed if it comes through a protocol we trust more (CDP, DHCP, LLDP,
or MAC).

diagnose command to calculate socket memory usage (392655)

This diagnostic command gives the socket memory usage by individual process.

diagnose sys process sock-mem <pid>; <pid> ...

Separate arguments with a semicolon ";"

Example

Run diagnose sys top to get the pid of a few process...

diagnose sys top
Run Time: 1 days, 0 hours and 44 minutes
0U, 0N, 0S, 100I, 0WA, 0HI, 0SI, 0ST; 7996T, 5839F
httpsd 214 S 0.1 0.2
httpsd 1398 S 0.1 0.2
snmpd 173 S 0.1 0.1

Then use those pid with the command...

diagnose sys process sock-mem 214; 173
Process ID=214, sock_mem=0(bytes)
Process ID=173, sock_mem=2(bytes)

FortiGuard can determine a FortiGate's location from its public IP address (393972)

The FortiGate now shows the public IP address and the geographical location (country) in the dashboard. The
FortiGate sends a ping to the FortiCare/FortiGuard network and as a response receives the local WAN IP, or if it
is being NATed the public IP of the network. Using the public IP address a geo-ip Blackpool is done to determine
the country.

In the same location on the Dashboard, it also shows whether or not the listed IP address if a member of the
Fortinet Blacklist.

CLI

The diagnostic command to get the information is:

diag sys waninfo

Example:

diagnose sys waninfo
Public/WAN IP: 209.87.240.98
Location:
Latitude: 45.250100
Longitude: -75.916100
Accuracy radius: 5
Time zone: America/Toronto
City: Stittsville
Subdivisions:
0: Ontario
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Country: Canada
Postal:
Code: K2S
Continent: North America
Registered country: Canada
ISP: Unknown

Failed to query whether 209.87.240.98 is in the FortiGuard IP Blacklist: ret=-1 buf_
sz=1024

Command fail. Return code 5

To get information about the address's inclusion as a member of the Fortinet Blacklist, the command is:

diag fortiguard ipblacklist [db | vr | ip | ctx]

l db - Get Database and Vendor/Reason List Versions.
l vr - Get Vendor/Reason List.
l ip - Get Information on Specific IP.
l ctx - Show Local Context.

If using the ip option, specify the IPv4 address after the ip option.

Example:

diagnose fortiguard ipblacklist ip 209.87.240.98

AWS bootstrapping diagnose commands (394158)

Bootstrap feature is quite similar to cloudinit in Openstack. When user launching a new instance of FGT-VM in
AWS, it needs to provide some basic information of license and config stored in AWS s3 bucket via userdata.
Bootstrap will download license and config from s3 bucket and apply them to FGT automatically.

CLI

Add a new cli to show the results of bootstrap config apply.

Example:

diagnose debug aws-bootstrap show
>> FGVM040000066475 $ config sys glo
>> FGVM040000066475 (global) $ set hostname awsondemand
>> FGVM040000066475 (global) $ end

Diagnose command to aid in conserver mode issues (394856)

The diagnose hardware sys conserve command provides memory information about the system that is
useful in diagnosing conserve mode issues.

Example

diagnose hardware sys conserve
memory conserve mode: off
total RAM: 7996 MB
memory used: 2040 MB 25% of total RAM
memory used threshold extreme: 7597 MB 95% of total RAM
memory used threshold red: 7037 MB 88% of total RAM
memory used threshold green: 6557 MB 82% of total RAM
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Diagnose commands to display FortiCare registration information (395254)

The Dashboard License widget can display information about the registered company owner and industry. There
are some diagnostic commands that can do that in the CLI.

diagnose forticare protocol [HTTP | HTTPS]
diagnose forticare server < server IP>
diagnose forticare cnreg-code-list - List of known ISO 3166-1 numeric country/region

codes.
diagnose forticare direct-registration reseller-list <cnreg-code>
diagnose forticare direct-registration country-data <cnreg-code>
diagnose forticare direct-registration organization-list
diagnose forticare direct-registration product-registration <arguments>

Options/arguments for product registration:

l a = account_id
l A = address
l y = city
l C = company
l c = contract_number
l T = country_code
l e = existing_account
l F = fax
l f = first_name
l h = help
l I = industry
l i = industry_id
l l = last_name
l O = orgsize
l o = orgsize_id
l p = password
l P = phone
l z = postal_code
l R = reseller
l r = reseller_id
l S = state
l s = state_code
l t = title
l v = version

new diag test app csfd options (395302)

Two additional test levels have been added to the diag test app csfd command in order to dump some
additional information about timers, file handlers status and received MAC addresses to the HAmaster.

diag test app csfd 11
diag test app csfd 40
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new 'AND' and 'OR' filter capabilities for debug flow addr (398985)

In order to make a more flexible filter for the debug flow address command, the Boolean arguments of 'AND' and
'OR' have been added to the command parser. This will work regardless of whether or not the source or
destination address is being filtered.

Syntax:

diagnose debug flow filter address <IP1|from IP> <IP2|to IP> <ENTER|and/or>

Improve wad debug trace and crash log information (400454)

Previously, when filtering on a wad debug trace or crash log information, the information may not have been as
targeted as necessary. A new setting has been added to target a specific policy.

diagnose wad filter firewall-policy <index>
diagnose wad filter explicit-policy <index>

These commands will target the firewall or explicit proxy policies. Using a "-1" as the value will index of that
particular policy type.

diagnose hardware test added to additional models (403571)

The diagnose hardware test that was previously on FortiGate E Series models, and the FortiGate 300/500D
models, has been expanded to include:

l Multiple low range models
l Multiple mid range models
l FortiGate 3800D model

This diagnostic feature replaces much of the functionality of the HQIP test that requires the installation of a
separate firmware image.

diag sys sip-proxy config profile --> diag sys sip-proxy config profiles (404874)

Diagnose command has been changed to make it more consistent with other similar commands.

diagnose sys sip-proxy config profile

has been changed to

diagnose sys sip-proxy config profiles

diag debug flow changes (405348)

For crash and console logs, the logs are no longer parsed before being sent to their destination. Now they are
dumped directly to the destination.

In addition the following options have been removed from the diagnose command list:

diag debug flow show console
diag debug flow show console enable
diag debug flow show console disable
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improve wad memory diagnose process (408236)

The WAD SSL memory dump functions have been moved to migbase so they can be shared by both WAD and
CLI.

CLI additions

l diagnose wad memory - WADmemory diagnostics
l diagnose wad memory general - List of WADmemory blocks.
l diagnose wad memory bucket List suspiciousWADmemory buckets.
l diagnose wad memory ssl List SSL memory statistics

New daemon watchdog framework in forticron (409243)

A new feature has been added to dump userspace's process stacks.

CLI additions:

diagnose sys process pstack <pid>

<pid> - Process ID, such as those displayed when using diagnose sys top

Output from diagnose wad debug command filterable(410069)

The output from the command was so verbose that there was some concern that the information that was being
looked for could get lost in all of the extraneous data so some parameters were added that allow the information
to be filtered by both severity level and the category of the information.

The command has a few settings

diagnose wad debug [enable|disable|show|clear|display]

l enable - Enable the level or category debug setting.
l disable - Disable debug setting.
l show - Show the current debug setting.
l clear - Clear the exiting debug setting.
l display - Changes to the Display setting.

l diag wad debug dispay pid enable - enables the display of PID values in the output.

Syntax to set the level

diagnose wad debug enable level <level>

Where the <level> is one of:

l error - error
l warn - warning
l info - information
l verbose - verbose
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Syntax to set the category

diag wad debug enable category <category>

Where <category> is one of the following:

l connection - connection
l session - session
l protocol - protocol
l io - I/O
l packet - packet
l db - cache database
l cifs - CIFS
l ssl - SSL
l webcache - webcache
l policy - policy matching
l auth - authentication
l scan - UTM scan
l cache - wanopt cache
l tunnel - wanopt tunnel
l bank - bank
l stats - stats
l disk - cache disk
l video - cache video
l rplmsg - replacement message
l ipc - IPC
l bar - Fortinet top bar
l waf - WAF
l memblk - memory block
l all - all catetory

DNS log improvements (410132)

DNS logs have been improved to make the presentation of the data clearer. These changes involve a
reorganization of the DNS log subtypes.

These changes include:

l Change dns-subtype to dns-response
l Remove status field and add Pass/Block/Redirect to action field
l Change the msg field display DNS filter rating results
l All error messages now to the error field
l Change urlfilteridx to domainfilteridx
l Change urlfilterlist to domainfilterlist
l Add a query type value field.
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Explicit web proxy (5.6)
New explicit web proxy features added to FortiOS 5.6.

Explicit proxy supports multiple incoming ports and port ranges (402775, 398687)

Explicit proxy can now be configured to listen on multiple ports on the same IP as well as listen for HTTP and
HTTPS on those same (or different) ports.

Define the IP ranges using a hyphen (-). As shown below, port_high is not necessary to specify if port_low is
equal to port_high.

CLI syntax

config web-proxy explicit
set http-incoming-port <port_low> [-<port_high>]

end

Explicit proxy supports IP pools (402221)

Added a new command, poolname, to config firewall proxy-policy. When setting the IP pool name
with this command, the outgoing IP will be selected.

CLI syntax

config firewall proxy-policy
edit <example>

set poolname <name>
end

Option to remove unsupported encoding from HTTP headers (392908)

Added a new command to config web-proxy profile that, when enabled, allows the FortiGate to strip
out unsupported encoding from request headers, and correctly block banned words. This is to resolve issues
when attempting to successfully block content using Google Chrome.

CLI syntax:

config web-proxy profile
edit <example>

set strip-encoding {enable | disable}
end

New authentication process for explicit web proxying (386474, 404355)

While in Proxy inspection mode, explicit proxy options can be set underNetwork > Explicit Proxy. These
settings will affect what options are available for creating proxy policies under Policy & Objects > Proxy
Policy. From here you may create new policies with Proxy Type set to either Explicit Web, Transparent
Web, or FTP.

Authentication will be triggered differently when configuring a transparent HTTP policy. Before such a policy can
be configured, you must enable HTTP Policy Redirect under Security Profiles > Proxy Options.
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Added Internet services to explicit proxy policies (386182)

Added two new commands to config firewall proxy-policy. FortiOS can use the Internet Service
Database (introduced in 5.4.1) as the web-proxy policy matching factor.

CLI syntax:

config firewall proxy-policy
edit <example>

set internet-service <application-id>
set internet-service-custom <application-name>

Virtual WAN link in an explicit proxy firewall policy (385849, 396780)

Virtual WAN link (VWL) interfaces may now be set as the destination interface in an explicit proxy policy, routing
traffic properly using basic virtual WAN link load balance settings. This is now configurable through both the CLI
under firewall proxy-policy and the GUI.

Added application ID and category setting on the explicit proxy enabled service (379330)

This feature introduces support for application ID/category in the service of explicit proxy as one policy selection
factor. The intent is to identify the application type based on the HTTP request with IPS application type
detection function. It is similar to the current firewall explicit address, but it is implemented as a service type, and
you can select the application ID/ category to define explicit service. Of course, now it must be an HTTP-based
application.

CLI syntax

config firewall service custom
edit "name"

set app-service-type [disable|app-id|app-category]
next

end

Explicit Proxy - populate pac-file-url in transparent mode (373977)

You can now use manageip to populate pac-file-url in transparent opmode. Previously, in the CLI, when
displaying pac-file-url, the code only tries to get interface IP to populate pac-file-url.

CLI syntax

config vdom
edit root
config system settings

set opmode transparent
set manageip 192.168.0.34/24

end
config web-proxy explicit

set pac-file-server-status enable
get pac-file-url [url.pac]

end

SSL deep inspection OCSP support for Explicit Proxy (365843)

OCSP support for SSL deep inspection added for Explicit Proxy.
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CLI syntax

config vpn certificate setting
set ssl-ocsp-status [enable|disable]
set ssl-ocsp-option [certificate|server]

end

Timed out authentication requests are now logged (357098)

CLI syntax

config web-proxy explicit
set trace-auth-no-rsp [enable|disable]

end
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Firewall (5.6.3)
New firewall features added to FortiOS 5.6.3.

Multi-port support for Explicit Proxy (402775)

Support has been added for the use of multiple ports and port range in the explicit FTP or Web proxies.These
changes have been added in both CLI and GUI.

CLI changes:

set http-incoming-port <port_low>[-<port_high>]

Where:

l port_low - the low value of the port
l port_high - the high value of the port

The port_high value can be omitted if port_low and port_high are the same.

Nturbo support CAPWAP traffic and fix IPsec IPv6 firewall policy code typo (290708) (423323)

NTurbo is used for IPSEC+IPS case. The IPSEC SA info is passed to NTURBO as part of VTAG for control packet
and will be used for the xmit.

If the packets need to go through IPSEC interface, the traffic will be always offloaded
to Nturbo. But for the case that SA has not been installed to NP6 because of hardware
limitation or SA offload disable, the packets will be sent out through raw socket by IPS
instead of Nturbo, since the software encryption is needed in this case.

CLI Changes:

Previously, NTurbo could only be enabled or disabled globally. The setting of np-acceleration has been added to
the firewall policy context instead of just the global context.

Add: Added a CLI command in the firewall policy to enable/disable NTurbo acceleration.

config firewall policy
edit 1

set np-accelation [enable|disable]
end

When IPS is enabled for VPN IPsec traffic, the data can be accelerated by NTurbo now.

Toggling SNAT in Central SNAT policies (434981)

The central NAT feature in not enabled by default. When central-nat is enabled, nat option under IPv4
policies is skipped and SNAT must be done via central-snat-map.

l Info messages and redirection links have been added to IPv4 policy list and dialog to indicate the above
l If NGFWmode is policy-based, then it is assumed that central-nat (specifically SNAT) is enabled implicitly
l The option to toggle NAT in central-snat-map policies has been added (previously it was only shown in NGFW

policy-based mode).
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l In central-snat policy dialog, the port-mapping fields for the original port have been updated to accept ranges.
l Nat will be skipped in firewall policy if per vdom central nat is enabled.

Example scenarios to show changes in how CLI treats central-nat

Change: make nat available regardless of NGFW mode.

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897
set nat enable
end

Change: hide nat-port if nat-ippool is not set or NAT is disabled.

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897
set nat disable
end

Change:change orig-port to accept range

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897 (help text changed to: Original port or port range).
set nat-port 35804-35805
end

Improved wildcard support for firewall fqdn (444646)

The following wildcard character instances are now supported in wildcard FQDN addresses:

l "?" character
l "*" character in the middle of a phrase
l The "?*" combination
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Policy Matching based on Referrer Headers and Query Strings (446257)

Web proxy policies support creating web proxy addresses to match referrer headers and query strings.

Matching referrer headers

For example, to create a web proxy address to match the referrer header to block access to the following
YouTube URL http://youtube.com/user/test321. The http request will have the following format:

GET /user/test321 HTTP/1.1
Host: www.youtube.com
User-Agent: curl/7.52.1
Accept: */*

Create the following web proxy addresses to match this page:

config firewall proxy-address
edit youtube

set type host-regex
set host-regex ".*youtube.com"

next
edit test321

set host "youtube"
set path "/user/test321"
set referrer enable

end

Then create two proxy policies, one that allows access to all traffic and a second one that blocks access to the
page that matches the referrer header:

config firewall proxy-policy
edit 1

set uuid 92273e4e-8c53-51e7-a7bd-f26e6e15fc98
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "all"
set service "webproxy-connect"
set action accept
set schedule "always"
set utm-status enable
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
edit 2

set uuid d35ad06a-8c53-51e7-8511-17200f682a4a
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "test321"
set service "webproxy"
set action accept
set schedule "always"
set utm-status enable
set av-profile "default"
set profile-protocol-options "test"
set ssl-ssh-profile "test"

end
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Matching query strings

To match the video with URL youtube.com/watch?v=XXXXXXXXX, (where XXXXXXXXX is an example YouTube
query string) you need to match an HTTP request with the following format:

GET /user/watch?v=GLCHldlwQsg HTTP/1.1
Host: www.youtube.com
User-Agent: curl/7.52.1
Accept: */*

Create the following web proxy addresses to match this video or query string:

config firewall proxy-address
edit "youtube"

set uuid 4ad63880-971e-51e7-7b2e-c69423ac6314
set type host-regex
set host-regex ".*youtube.com"

next
edit "query-string"

set uuid 7687a8c0-9727-51e7-5063-05edda03abbf
set host "youtube"
set path "/watch"
set query "v=XXXXXXXXX"

end

Then create two proxy policies, one that allows access to all traffic and a second one that blocks access to the
page that matches the query string

config firewall proxy-policy
edit 1
set uuid 92273e4e-8c53-51e7-a7bd-f26e6e15fc98

set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "all"
set service "webproxy-connect"
set action accept
set schedule "always"
set utm-status enable
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
edit 2

set uuid d35ad06a-8c53-51e7-8511-17200f682a4a
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "query-string"
set service "webproxy"
set action accept
set schedule "always"
set utm-status enable
set av-profile "default"
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
end
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Firewall (5.6.1)
New firewall features added to FortiOS 5.6.1.

Improvement to NAT column in Policy List Display (305575)

The NAT column in the listing of Policy can provide more information than before.

Previously the field for the policy in the column only showed whether NAT wasEnabled orDisabled.

With the new improvements, not only does the field show the name of the Dynamic Pool, if one is being used, but
the tool-tip feature is engaged if you hover the cursor over the icon in the field and provides even more specific
information.

GUI support for adding Internet-services to proxy-policies (405509)

There is now GUI support for the configuration of adding Internet services to proxy policies. When choosing a
destination address for a Proxy Policy, the Internet Service tab is visible and the listed objects can be selected.
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By choosing an Internet Service object as the Destination, this sets internet-service to enable and
specifying either an Address or IPv6 Address object will set internet-service to disable.

Inline editing of profile groups on policy (409485)

There can now be editing to the profile groups within the policy list display window. Before, you had to go into the
edit window of the policy, such as in the image below:

However, now the editing can be done from the list display of policies and clicking on the GRP icon. Right clicking
on the icon will slide a window out from the left and left clicking will give you a drop-down menu.
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Rename "action" to "nat" in firewall.central-snat-map (412427)

The action field option in thecontext of firewall central-snat-map in the CLI was considered by some
to be a little ambiguous, so it has been renamed to nat, an option that can either be enabled or disabled.

Explicit proxy supports session-based Kerberos authentication (0437054)

l Explicit proxy supports session-based Kerberos authentication
l Transparent proxy will create an anonymous user if the an attempt to create a NTLM connection fails.
l When FSSO authentication fails for the explicit FTP proxy, the FortiGate responses with the error message "match

policy failed".

Firewall (5.6)
New firewall features added to FortiOS 5.6.

Optimization of the firewall Service cache (355819)

In order to improve the efficiency and performance of the firewall Service cache, the following improvements
have been made:

l The logic behind the structure of the cache has been simplified. Instead of storing ranges of port numbers, we store
each individual port number in the cache

l Separate caches are created for each VDOM so that cache searches are faster.
l The performance of more frequently used cases has been increased
l Hash tables are used to improve the performance of complex cases. These could include such instances as:

l service names tied to specific IP Ranges
l redefinition (one port number with multiple service names)

New CLI option to prevent packet order problems for sessions offloaded to NP4 or NP6
(365497)

In order to prevent the issue of a packet, on FortiGate processing a heavy load of traffic, from being processed
out of order, a new setting has been added to better control the timing of pushing the packets being sent to NP
units.

The new option, delay-tcp-npc-session, has been added into the context of config firewall policy within the CLI

config firewall policy
edit <Integer for policy ID>

set delay-tcp-npc-session
end

Policy may not be available on units not using NP units.

GUI changes to Central NAT (371516)

The Central NAT configuration interface prevents the accidental occurrence of being able to select “all” and
“none” as two objects for the same field. It only allows the selecting of a single IP pool, though it is still possible to

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

161



What's New in previous versions of FortiOS 5.6 Chapter 1 - What's New for FortiOS 5.6

select multiple IP pools within the CLI.

Max value for Firewall User authentication changed (378085)

Previously, the maximum time that a member of a firewall user group could remain authenticated without any
activity was 24 hours (1440 minutes). The maximum value for this setting has been changed to 72 hours (4320
minutes). This allow someone to log in but not be kicked off the system due to inactivity over the course of a
weekend.

The syntax in the CLI for configuring this setting is:

config user group
edit <name of user group>

set authtimeout 4320
end

Changes to default SSL inspection configuration (380736)

SSL is such a big part of normal traffic that SSL certificate inspection is no longer disabled by default. SSL
inspection is now mandatory in firewall policies whenever a policy includes a security profile. The default setting is
the Certificate Inspection level. As a result there have been a few changes within the CLI and the GUI.

CLI

The setting SSL-SSH-Profile, is a required option, with the default value being “certificate-inspection”, when it is
applicable in the following tables:

l firewall.profile-group
l firewall.policy
l firewall.policy6,
l firewall.proxy-policy

The following default profiles are read-only:

l certificate-inspection
l deep-ssl-inspection

GUI

IPv4/IPv6 Policy and Explicit Proxy Policy edit window

l The configuration and display set up for SSL/SSH Inspection is now similar to "profile-protocol-option" option
l The disable/enable toggle button is no longer available for the Profile Protocol Option
l The default profile is set to "certificate-inspection"

IPv4/IPv6 Policy, Explicit Proxy Policy list page

l There is validation for SSL-SSH-Profile when configuring UTM profiles

SSL/SSH Inspection list page

l There is no delete menu on GUI for default ssl profiles
l The "Edit" menu has been changed to "View" for default SSL profiles
l The default SSL profile entries are considered an implicit class and are grayed out

SSL/SSH Inspection edit window
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l The only input for default SSL profiles is now download/view trusted certificate links
l To return to the List page from default SSL profiles, the name of the button is now "Return"

Profile Group edit window

l There is no check box for SSL-SSH-Profile. It is always required.

Name change conventions due to upgrade

Starting in 5.6, the profiles "certificate-inspection" and "deep-inspection" are set up by the firmware as default
read-only profiles. If you have profiles with these names that were configured in a previous version of FortiOS,
rather than overwrite the firmware's default profile, profiles with these names will be upgraded to reflect the
configuration conventions of the new firmware but the profile names will be changed by adding a prefix of "_upg_
".

Add firewall policy comment field content to log messages (387865)

There has been a need by some customer to have some information in the logs that includes specific information
about the traffic that produced the log. The rather elegant solution is that when the log-policy-comment option is
enabled, the comment field from the policy will be included in the log. In order to make the logs more useful
regarding the traffic just include a customized comment in the policy and enable this setting.

Syntax

config system settings
set log-policy-comment [enable | disable]
end

l This setting is for all traffic and security logs.
l It can be select on a per VDOM basis

Learning mode changes profile type to single (387999)

The Learning mode does not function properly when it is applied to a policy that has a UTM profile group applied
to it. The logging that should be taking place from the Learning Mode profiles does not occur as intended, and the

Automatically switching the profile type to single on a policy with Learning mode enabled prevents it from being
affected by the UTM policy groups.

MAC address authentication in firewall policies and captive portals (391739)

When enabled, a MAC authentication request will be sent to fnbamd on any traffic. If the authentication receives
a positive response, login becomes available. If the response is negative the normal authentication process takes
over.

CLI

New option in the firewall policy setting

config firewall policy
edit <policy ID>

set radius-mac-auth-bypass [enable |disable]
end

New option in the interface setting
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config system interface
edit <interface>

set security-mode captive-portal
set security-mac-auth-bypass
end

Display resolved IP addresses for FQDN in policy list (393927)

If a FQDN address object is used in a policy, hovering the cursor over the icon for that object will show a tool tip
that lists the parameters of the address object. This tool tip now includes the IP address that the FQDN resolves
to.

Added comment for acl-policy, interface-policy and DoS-policy (396569)

A comment field has been added to the following policy types:

l acl-policy

l interface-policy

l DoS-policy

Comments of up to 1023 characters can be added through the CLI.

Examples:

DoS policy

config firewall DoS-policy
edit 1

set comment "you can put a comment here(Max 1023)."
set interface "internal"
set srcaddr "all"
set dstaddr "all"
set service "ALL"
config anomaly

edit "tcp_syn_flood"
set threshold 2000
next

end
end

Interface policy

config firewall interface-policy
edit 1

set comment "you can put a comment here(max 1023)."
set interface "dmz2"
set srcaddr "all"
set dstaddr "all"
set service "ALL"
end

Firewall ACL

config firewall acl
edit 1

set status disable
set comment "you can put a comment here(max 1023)."

164 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New in previous versions of FortiOS 5.6

set interface "port5"
set srcaddr "all"
set dstaddr "all"
set service "ALL"

end

Internet service settings moved to more logical place in CLI (397029)

The following settings have moved from the application context of the CLI to the firewall context:

l internet-service

l internet-service-custom

Example of internet-service

config firewall internet-service 1245324
set name "Fortinet-FortiGuard"
set reputation 5
set icon-id 140
set offset 1602565

config entry
edit 1

set protocol 6
set port 443
set ip-range-number 27
set ip-number 80
next

edit 2
set protocol 6
set port 8890
set ip-range-number 27
set ip-number 80
next

edit 3
set protocol 17
set port 53
set ip-range-number 18
set ip-number 31
next

edit 4
set protocol 17
set port 8888
set ip-range-number 18
set ip-number 31
next

end

Example of internet-service-custom

config firewall internet-service-custom
edit "custom1"

set comment "custom1"
config entry

edit 1
set protocol 6

config port-range
edit 1

set start-port 30
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set end-port 33
next

end
set dst "google-drive" "icloud"
next

end
next

end

Example of get command:

get firewall internet-service-summary
Version: 00004.00002
Timestamp: 201611291203
Number of Entries: 1349

Certificate key size selection (397883)

FortiOS will now support different SSL certificate key lengths from the HTTPS server. FortiOS will select a key
size from the two options of 1024 and 20148, to match the key size (as close as possible, rounding up) on the
HTTS server. If the size of the key from the server is 512 or 1024 the proxy will select a 1024 key size. If the key
size from the servers is over 1024, the proxy will select a key size of 2048.

CLI changes:

In ssl-ssh-profile remove:

l certname-rsa

l certname-dsa

l certname-ecdsa

In vpn certificate setting, add the following options :

l certname-rsa1024

l certname-rsa2048

l certname-dsa1024

l certname-dsa2048

l certname-ecdsa256

l certname-ecdsa384

AWS API integration for dynamic firewall address object (400265)

Some new settings have been added to the CLI that will support instance information being retrieved directly
from the AWS server. The IP address of a newly launched instance can be automatically added to a certain
firewall address group if it meets specific requirements. The new address type is:ADDR_TYPE_AWS

New CLI configuration settings:

The AWS settings

config aws
set access-key
set secret-key
set region
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set vpc-id
set update-interval

l access-key - AWS access key.
l secret-key - AWS secret key.
l region - AWS region name.
l vpc-id - AWSVPC ID.
l update-interval - AWS service update interval (60 - 600 sec, default = 60).

The AWS address:

config firewall address
edit <address name>

set type aws
set filter <filter values>

The filter can be a combination of any number of conditions, as long as the total length

of filter is less than 2048 bytes. The syntax for the filter is:

<key1=value1> [& <key2=value2>] [| <key3=value3>]

For each condition, it includes a key and value, the supported keys are:

1. instanceId, (e.g. instanceId=i-12345678)
2. instanceType, (e.g. instanceType=t2.micro)
3. imageId, (e.g. imageId=ami-123456)
4. keyName, (e.g. keyName=aws-key-name)
5. architecture, (e.g. architecture=x86)
6. subnetId, (e.g. subnetId=sub-123456)
7. placement.availabilityzone, (e.g. placement.availabilityzone=us-east-1a)
8. placement.groupname, (e.g. placement.groupname=group-name)
9. placement.tenancy, (e.g. placement.tenancy=tenancy-name)
10. privateDnsName, (e.g. privateDnsName=ip-172-31-10-211.us-west-2.compute.internal)
11. publicDnsName, (e.g. publicDnsName=ec2-54-202-168-254.us-west-2.compute.amazonaws.com)
12. AWS instance tag, each tag includes a key and value, the format of tag set is: tag.Name=Value, maximum of 8

tags are supported.

Internet service configuration (405518)

To make the CLI configuration of Internet service configuration more intuitive, the settings for Internet service in
Explicit Web proxy are closer to those in the Firewall police. An Internet service enable switch has been added to
the Explicit Web proxy with the same text description as the Firewall policy.

CLI:

The relevant options in the firewall policy are:

config firewall policy
edit 1

set internet-service enable
set internet-service-id 327681 1572864 917519 393225 1572888 1572877 917505
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next
end

The Explicit Web proxy is now has these options:

config firewall proxy-policy
edit 1
set uuid f68e0426-dda8-51e6-ac04-37fc3f92cadf
set proxy explicit-web
set dstintf "port9"
set srcaddr "all"
set internet-service 2686980
set action accept
set schedule "always"
set logtraffic all
next
end

Changes to SSL abbreviate handshake (407544)

The SSL handshake process has changed to make troubleshooting easier.

l In order to better identify which clients have caused SSL errors, the WAD SSL log will use the original source
address rather than the source address of packets.

l The return value of wad_ssl_set_cipher is checked.
l The wad_ssl_session_match has been removed because it will add the connection into bypass cache and

bypass further inspection.
l DSA and ECDSA certificates are filtered for admin-server-cert
l cert-inspect is reset after a WADmatch to a Layer 7 policy
l An option to disable the use of SSL abbreviate handshake has been added

CLI addition

config firewall ssl setting
set abbreviate-handshake [enable|disable]

NGFW mode in the VDOM - NAT & SSL Inspection considerations (407547)

Due to how the NGFW Policy mode works, it can get complicated in the two areas of NAT and SSL Deep
Inspection. To match an application against a policy, some traffic has to pass through the FortiGate in order to be
properly identified. Once that happens may end up getting mapped to a different policy, where the new policy will
be appropriately enforced.

NAT

In the case of NAT being used, the first policy that is triggered to identify the traffic might require NAT enabled for
it to work correctly. i.e., without NAT enabled it may never be identified, and thus not fall through. Let's use a
very simple example:

Policy 1: Block Youtube

Policy 2: Allow everything else (with NAT enabled)
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Any new session established will never be identified immediately as Youtube, so it'll match policy #1 and let some
traffic go to try and identify it. Without NAT enabled to the Internet, the session will never be setup and thus
stuck here.

Solution:

l NAT for NGFW policies must be done via Central SNAT Map
l Central SNAT Map entries now have options for 'srcintf', 'dstintf' and 'action'.
l If no IP-pools are specified in the Central SNAT entry, then the outgoing interface address will be used.
l NGFW policies now must use a single default ssl-ssh-profile. The default ssl-ssh-profile can be configured under

the system settings table.

SSL

In the case of SSL inspection, the issue is a bit simpler. For each policy there are 3 choices:

1. No SSL,
2. Certificate Only
3. Deep Inspection.
For 1. and 2. there is no conflict and the user could enable them inter-changeably and allow policy fallthrough.

The issue happens when:

l The first policy matched, usesCertificate Only
l After the application is detected, it re-maps the session to a new policy which hasDeep Inspection enabled

This switching of behavior is the main cause of the issue.

Solution:

l Multiple SSL profiles have been replaced with a single page of settings
l The user can setup exemptions for destination web category, source IP or etc.

CLI

Changes

config system settings
set inspection-mode flow
set policy-mode [standard | ngfw]

Has been changed to:

config system settings
set inspection-mode flow
set ngfw-mode [profile-based | policy-based]

l ngfw-mode - Next Generation Firewall mode.
l profile-based - Application and web-filtering is configured using profiles applied to policy entries.
l policy-based - Application and web-filtering is configured as policy match conditions.
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Additions

Setting the vdom default ssl-ssh-profile

config system settings
set inspection-mode flow
set ngfw-mode policy-based
set ssl-ssh-profile <profile>

ssl-ssh-profile - VDOM SSL SSH profile.

Setting srcintf, dstintf, action on the central-snat policy

config firewall central-snat-map
edit <id>

set srcintf <names or any>
set dstintf <names or any>
set action (permit | deny)

l srcintf - Source interface name.
l dstintf - Destination interface name.
l action - Action of central SNAT policy.

GUI

System settings, VDOM settings list/dialog:

l A field has been added to show the default ssl-ssh-profile

IPv4/v6 Policy list and dialogs:

l In NGFW policy-based mode, there are added tool tips under NAT columns/fields to indicate that NAT must be
configured via Central SNAT Map. Additionally, links to redirect to Central SNAT list were added.

l Default ssl-ssh-profile is shown in the policy list and dialog for any policies doing NGFW (`application,
application-categories, url-categories`) or UTM (`av-profile etc.) inspection.
l Default ssl-ssh-profile is disabled from editing in policy list dialog

Central SNAT Policy list and dialogs:

l In both profile-based & policy-based ngfw-mode, fields for srcintf, dstintf were added to Central
SNAT policies entries.

l In policy-based mode only, a toggle-switch forNAT Action was added in Central SNAT policy dialog. The
action is also configurable from the Action column in Central SNAT policy list.

SSL/SSH Inspection list:

l In policy-based mode only, the navigation bar link to SSL/SSH Inspection redirects to the profiles list
l In policy-based mode only, the SSL/SSH Inspection list table indicates which profile is the current VDOM default.

Additionally, options are provided in the list menu and context menu to change the current VDOM default.
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Support HTTP policy for flow-based inspection (411666)

It is possible to impliment an HTTP-policy in a VDOM that is using the Flow-based inspection mode. Enabling the
HTTP-policy causes the traffic to be redirected to WAD so that the traffic can be properly matched and processed.

Support for CA chain downloading to improve certificate verification (369270)

During certificate verification, if the certificate chain is not complete and CA issuer information exists in the
certifcate, FortiOS attempts to download intermediate/root CAs from the HTTP server and attempts to perform
chain verification. The downloaded CAs are saved in a cache (max 256) to be re-used for future certificate
validation. CAs are removed from the cache if they are inactive or not needed for more than 1 hour.

CA chain downloading is used to improve verification results for certificates that are difficult to verify. The CAs are
kept in the cache to improve performance.

Managed FortiSwitch OS 3.6.0 (FortiOS 5.6.3)
Newmanaged FortiSwitch features added to FortiOS 5.6.3 if the FortiSwitch is running FortiSwitch OS 3.6.0.

Firewall policy now required for RADIUS traffic (434470)

In FortiLink mode, you must manually create a firewall policy to allow RADIUS traffic for 802.1x authentication
from the FortiSwitch (for example, from the FortiLink interface) to the RADIUS server through the FortiGate.

STP root guard (376015)

Enable root guard on all ports that should not be root bridges. Do not enable root guard on the root port. You must
have STP enabled to be able to use root guard.

Using the FortiGate GUI

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Right-click on a port.
3. Select Enable orDisable.

Using the FortiGate CLI

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set stp-root-guard {enabled | disabled}
end

end

STP BPDU guard (406182)

When BPDU guard is enabled on STP edge ports, any BPDUs received cause the ports to go down for a specified
number of minutes. The BPDUs are not forwarded, and the network edge is enforced.

There are two prerequisites for using BPDU guard:
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l You must define the port as an edge port with the set edge-port enable command.
l You must enable STP on the switch interface with the set stp-state enabled command.

Using the FortiGate GUI

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Right-click on a port.
3. Select Enable orDisable.

Using the FortiGate CLI

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set stp-bpdu-guard {enabled | disabled}
set stp-bpdu-guard-time <0-120>

end
end

FortiSwitch log message changes (438738)

More details are now provided in exported FortiSwitch logs, for example:

l New Switch-Controller user field and daemon-name ui fields.
l Removed Switch-Controller keyword from the msg field
l Changed UpdSwConf keyword in msg field to FortiSwitch in flcfgd logs
l Removed the VDOM keyword from the msg field in flcfgd logs
l Removed the Fortiswitch keyword before SN in the msg field
l Changed syslog to have switch SN first followed by a space and then the first word following with a capital (in the

msg field)

Use the following CLI commands to enable the export of FortiSwitch logs and to set the level of logging included.
The system logs all messages at and above the logging severity level you select. For example, if you select
error, the system logs error, critical, alert, and emergency level messages.

config switch-controller switch-log
set status (*enable | disable)
set severity [emergency | alert | critical | error | warning | notification |

*information | debug]
end

Support FSW BPDU Guard (442921) (442922)

With standard STP, a device that sends BPDU(s) to any switch port becomes a member of that switch’s STP
network topology. In order to enforce a network edge, the access ports on the switch can be configured with
BPDU guard. With BPDU guard enabled, the port does not forward BPDUs upstream (toward its root bridge).
Instead, when a BPDU guard enabled port receives any BPDU, it immediately puts the port into a blocking state
and alerts the user.

This prevents the access port from accepting the downstream device, removing it from the receiving switch’s STP
calculations. In order to unblock the port after bpdu guard has triggered, the user must execute a reset command.
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After the port is reset, it will resume normal operation and return to a blocking state only if another BPDU is
received.

BPDU guard is typically used in conjunction with Root Guard to enforce a specific network topology.

Syntax

config switch-controller managed-switch
edit <switch SN>

config ports
edit <port>

set stp-bpdu-guard <enable | *disable>
set stp-bpdu-guard-timeout <time> (0-120 in minutes)

next
end

next
end

config switch-controller managed-switch
edit <switch SN>

config ports
edit <port>

set stp-root-guard <enable | *disable>
next

end
next

end

diagnose switch-controller dump stp <switch SN> <instance>
diagnose switch-controller bpdu-guard-status <switch SN>

Managed switch CLI features added to GUI (448722)

Added new optional columns "Edge Port", "LLDP Profile", "QoS Policy", "STP BPDU Guard", "STP Root Guard" in
WiFi & Switch Controller > FortiSwitch Ports.

This would allow administrators to make changes to the features above to multiple switch ports at the same time.

Added unit in help-text when setting max-rate/min-rate under switch-controller qos queue-
policy (449487) (449869)

Modified the CLI help-text on the FortiGate to show priority under strict schedule when setting max-rate/min-rate
under switch-controller qos queue-policy.

Syntax

set priority-0
queue-0 COS queue 0. (lowest priority)
queue-1 COS queue 1.
queue-2 COS queue 2.
queue-3 COS queue 3.
queue-4 COS queue 4.
queue-5 COS queue 5.
queue-6 COS queue 6.
queue-7 COS queue 7. (highest priority)
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Added FortiSwitch factory-reset functionality to the FortiOS GUI (393205)

Added a Factory Reset button to theWiFi & Switch Controller > Managed FortiSwitch page when a
FortiSwitch document is selected.

Syntax

execute switch-controller factory-rest <switch sn>

Managed FortiSwitch OS 3.6.0 (FortiOS 5.6.1)
Newmanaged FortiSwitch features added to FortiOS 5.6.1 if the FortiSwitch is running FortiSwitch OS 3.6.0.

Simplified method to convert a FortiSwitch to standalone mode (393205)

There is an easier way to convert a FortiSwitch from FortiLink mode to standalone mode so that it will no longer
be managed by a FortiGate:

l execute switch-controller factory-reset <switch-id>
This command returns the FortiSwitch to the factory defaults and then reboots the FortiSwitch. If the FortiSwitch is
configured for FortiLink auto-discovery, FortiGate can detect and automatically authorize the FortiSwitch.

l execute switch-controller set-standalone <switch-id>
This command returns the FortiSwitch to the factory defaults, reboots the FortiSwitch, and prevents the FortiGate
from automatically detecting and authorizing the FortiSwitch.

You can disable FortiLink auto-discovery on multiple FortiSwitches using the following commands:

config switch-controller global
set disable-discovery <switch-id>

end

You can also add or remove entries from the list of FortiSwitches that have FortiLink auto-discovery disabled
using the following commands:

config switch-controller global
append disable-discovery <switch-id>
unselect disable-discovery <switch-id>

end

Quarantines (410828)

Quarantined MAC addresses are blocked on the connected FortiSwitches from the network and the LAN.

NOTE: You must enable the quarantine feature in the FortiGate CLI using the set quarantine enable
command. You can add MAC addresses to the quarantine list before enabling the quarantine feature, but the
quarantine does not go into effect until enabled.

Quarantining a MAC address

Using the FortiGate GUI

1. Select the host to quarantine.
l Go to Security Fabric > Physical Topology, right-click on a host, and select Quarantine Host on
FortiSwitch.

174 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New in previous versions of FortiOS 5.6

l Go to Security Fabric > Logical Topology, right-click on a host, and select Quarantine Host on
FortiSwitch.

l Go to FortiView > Sources, right-click on an entry in the Source column, and select Quarantine Host
on FortiSwitch.

2. ClickOK to confirm that you want to quarantine the host.

Using the FortiGate CLI

config switch-controller quarantine
set quarantine enable

edit <MAC_address>
set description <string>
set tags <tag1 tag2 tag3 ...>

next
next

end

Option Description

MAC_address A layer-2 MAC address in the following format: 12:34:56:aa:bb:cc

string Optional. A description of the MAC address being quarantined.

tag1 tag2 tag3 ... Optional. A list of arbitrary strings.

Viewing quarantine entries

Quarantine entries are created on the FortiGate that is managing the FortiSwitch.

Using the FortiGate GUI

1. Go toMonitor > Quarantine Monitor.
2. ClickQuarantined on FortiSwitch.

Using the FortiGate CLI

Use the following command to view the quarantine list of MAC addresses:

show switch-controller quarantine

When the quarantine feature is enabled on the FortiGate, it creates a quarantine VLAN (qtn.<FortiLink_port_
name>) on the virtual domain. The quarantine VLAN is applied to the allowed and untagged VLANs on all
connected FortiSwitch ports.

Use the following command to view the quarantine VLAN:

show system interface qtn.<FortiLink_port_name>

Use the following command to view how the quarantine VLAN is applied to the allowed and untagged VLANs on
all connected FortiSwitch ports:

show switch-controller managed-switch
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Releasing MAC addresses from quarantine

Using the FortiGate GUI

1. Go toMonitor > Quarantine Monitor.
2. ClickQuarantined on FortiSwitch.
3. Right-click on one of the entries and select Delete orRemove All.
4. ClickOK to confirm your choice.

Using the FortiGate CLI

Use the following commands to delete a quarantined MAC address:

config switch-controller quarantine
config targets

delete <MAC_address>
end

When the quarantine feature is disabled, all quarantined MAC addresses are released from quarantine. Use the
following commands to disable the quarantine feature:

config switch-controller quarantine
set quarantine disable

end

Assign untagged VLANs to a managed FortiSwitch port (410828)

Use the following commands to assign untagged VLANs to a managed FortiSwitch port:

config switch-controller managed-switch
edit <managed-switch>

config ports
edit <port>

set untagged-vlans <VLAN-name>
next

end
next

end

View, create, and assign multiple 802.1X policy definitions (408389 and 403901)

Previously, you could create one 802.1X policy for all managed FortiSwitches in a virtual domain. Now, you can
create multiple 802.1X policies and assign a different 802.1X policy to each managed FortiSwitch port.

View security policies for managed FortiSwitches

You can view security policies for managed FortiSwitches in two places:

l Go toWiFi & Switch Controller > FortiSwitch Security Policies.
l Go toWiFi & Switch Controller > FortiSwitch Ports and click the + next to a FortiSwitch. The security policy

for each port is listed in the Security Policy column.
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Create and assign multiple 802.1X policy definitions for managed FortiSwitches

Previously, you could create one 802.1X policy for all managed FortiSwitches in a virtual domain. Now, you can
create multiple 802.1X policies and assign a different 802.1X policy to each managed FortiSwitch port.

To create an 802.1X security policy:

1. Go toWiFi & Switch Controller > FortiSwitch Security Policies.
2. ClickCreate New.
3. Enter a name for the new FortiSwitch security policy.
4. For the security mode, select Port-based orMAC-based.
5. Click + to select which user groups will have access.
6. Enable or disable guest VLANs on this interface to allow restricted access for some users.
7. Enter the number of seconds for authentication delay for guest VLANs. The range is 60-900 seconds.
8. Enable or disable authentication fail VLAN on this interface to allow restricted access for users who fail to access

the guest VLAN.
9. Enable or disable MAC authentication bypass (MAB) on this interface.
10. Enable or disable EAP pass-through mode on this interface.
11. Enable or disable whether the session timeout for the RADIUS server will overwrite the local timeout.
12. ClickOK.
To apply an 802.1X security policy to a managed FortiSwitch port:

1. Go toWiFi & Switch Controller > FortiSwitch Ports.
2. Click the + next to a FortiSwitch.
3. In the Security Policy column for a port, click + to select a security policy.
4. ClickOK to apply the security policy to that port.

Override 802.1X settings

To override the 802.1X settings for a virtual domain:

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Click on a FortiSwitch faceplate and clickEdit.
3. In the Edit Managed FortiSwitch page, move theOverride 802-1X settings slider to the right.
4. In the Reauthentication Interval field, enter the number of minutes before reauthentication is required. The

maximum interval is 1,440 minutes. Setting the value to 0 minutes disables reauthentication.
5. In the Max Reauthentication Attempts field, enter the maximum times that reauthentication is attempted. The

maximum number of attempts is 15. Setting the value to 0 disables reauthentication.
6. Select Deauthenticate orNone for the link down action. Selecting Deauthenticate sets the interface to

unauthenticated when a link is down, and reauthentication is needed. Selecting Nonemeans that the interface
does not need to be reauthenticated when a link is down.

7. ClickOK.

Enable and disable switch-controller access VLANs through FortiGate (406718)

Access VLANs are VLANs that aggregate client traffic solely to the FortiGate. This prevents direct client-to-client
traffic visibility at the layer-2 VLAN layer. Clients can only communicate with the FortiGate. After the client traffic
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reaches the FortiGate, the FortiGate can then determine whether to allow various levels of access to the client by
shifting the clientʼs network VLAN as appropriate.

Use enable to allow traffic only to and from the FortiGate and to block FortiSwitch port-to-port traffic on the
specified VLAN. Use disable to allow normal traffic on the specified VLAN.

config system interface
edit <VLAN name>

set switch-controller-access-vlan {enable | disable}
next

end

Override the admin password for all managed FortiSwitches (416261)

By default, each FortiSwitch has an admin account without a password. To replace the admin passwords for all
FortiSwitches managed by a FortiGate, use the following commands:

config switch-controller switch-profile
edit default

set login-passwd-override {enable | disable}
set login-passwd <password>

next
end

If you had already applied a profile with the override enabled and the password set and then decide to remove the
admin password, you need to apply a profile with the override enabled and use the unset login-passwd
command; otherwise, your previously set password will remain in the FortiSwitch.

Configure an MCLAG with managed FortiSwitches (366617)

To configure a multichassis LAG (MCLAG) with managed FortiSwitches:

1. For each MCLAG peer switch, log into the FortiSwitch to create a LAG:

config switch trunk
edit "LAG-member"

set mode lacp-active
set mclag-icl enable
set members "<port>" "<port>"

next
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2. Enable the MCLAG on each managed FortiSwitch:

config switch-controller managed-switch
edit "<switch-id>"

config ports
edit "<trunk name>"

set type trunk
set mode {static | lacp-passive | lacp-active}
set bundle {enable | disable}
set members "<port>,<port>"
set mclag {enable | disable}

next
end

next

3. Log into each managed FortiSwitch to check the MCLAG configuration:

diagnose switch mclag

After the FortiSwitches are configured as MCLAG peer switches, any port that supports advanced features on the
FortiSwitch can become a LAG port. When mclag is enabled and the LAG port names match, an MCLAG peer
set is automatically formed. The member ports for each FortiSwitch in the MCLAG do not need to be identical to
the member ports on the peer FortiSwitch.

Configure QoS with managed FortiSwitches (373581)

Quality of Service (QoS) provides the ability to set particular priorities for different applications, users, or data
flows. NOTE: FortiGate does not support QoS for hard or soft switch ports.

To configure the QoS for managed FortiSwitches:

1. Configure a Dot1p map.

config switch-controller qos dot1p-map
edit <Dot1p map name>

set description <text>
set priority-0 <queue number>
set priority-1 <queue number>
set priority-2 <queue number>
set priority-3 <queue number>
set priority-4 <queue number>
set priority-5 <queue number>
set priority-6 <queue number>
set priority-7 <queue number>

next
end

2. Configure a DSCPmap.

config switch-controller qos ip-dscp-map
edit <DSCP map name>

set description <text>
configure map <map_name>

edit <entry name>
set cos-queue <COS queue number>
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set diffserv {CS0 | CS1 | AF11 | AF12 | AF13 | CS2 | AF21 | AF22 | AF23
| CS3 | AF31 | AF32 | AF33 | CS4 | AF41 | AF42 | AF43 | CS5 | EF |
CS6 | CS7}

set ip-precedence {network-control | internetwork-control | critic-ecp
| flashoverride | flash | immediate | priority | routine}

set value <DSCP raw value>
next

end
end

3. Configure the egress QoS policy.

config switch-controller qos queue-policy
edit <QoS egress policy name>

set schedule {strict | round-robin | weighted}
config cos-queue
edit [queue-<number>]

set description <text>
set min-rate <rate in kbps>
set max-rate <rate in kbps>
set drop-policy {taildrop | random-early-detection}
set weight <weight value>
next

end
next

end

4. Configure the overall policy that will be applied to the switch ports.

config switch-controller qos qos-policy
edit <QoS egress policy name>

set default-cos <default CoS value 0-7>
set trust-dot1p-map <Dot1p map name>
set trust-ip-dscp-map <DSCP map name>
set queue-policy <queue policy name>

next
end

5. Configure each switch port.

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port>

set qos-policy <CoS policy>
next

end
next

end

Reset PoE-enabled ports from the GUI (387417)

If you need to reset PoE-enabled ports, go toWiFi & Switch Control > FortiSwitch Ports, right-click on one
or more PoE-enabled ports and select Reset PoE from the context menu.
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You can also go toWiFi & Switch Control > Managed FortiSwitch and click on a port icon for the FortiSwitch
of interest. In the FortiSwitch Ports page, right-click on one or more PoE-enabled ports and select Reset PoE
from the context menu.

Adding preauthorized FortiSwitches (382774)

After you preauthorize a FortiSwitch, you can assign the FortiSwitch ports to a VLAN.

To preauthorize a FortiSwitch:

1. Go toWiFi & Switch Controller >Managed FortiSwitch.
2. ClickCreate New.
3. In the New Managed FortiSwitch page, enter the serial number, model name, and description of the FortiSwitch.
4. Move the Authorized slider to the right.
5. ClickOK.

The Managed FortiSwitch page shows a FortiSwitch faceplate for the preauthorized switch.

Managed FortiSwitch OS 3.6.0 (FortiOS 5.6)
Newmanaged FortiSwitch features added to FortiOS 5.6 if the FortiSwitch is running FortiSwitch OS 3.6.0.

IGMP snooping (387515)

The GUI and CLI support the ability to configure IGMP snooping for managed switch ports.

To enable IGMP snooping from the GUI, go toWiFi & Switch Controller > FortiSwitch VLANs, edit a VLAN
and turn on IGMP Snooping underNetworked Devices.

From the CLI, start by enabling IGMP snooping on the FortiGate:

config switch-controller igmp-snooping
set aging-time <int>
set flood-unknown-multicast (enable | disable)

end

Then enable IGMP snooping on a VLAN:

config system interface
edit <vlan>

set switch-controller-igmp-snooping (enable | disable)
end

Use the following command to enable IGMP snooping on switch ports, and to override the global parameters for
a specific switch.

config switch-controller managed-switch
edit <switch>

config ports
edit port <number>

set igmp-snooping (enable | disable)
set igmps-flood-reports (enable | disable)

next
config igmp-snooping globals

set aging-time <int>
set flood-unknown-multicast (enable | disable)

end
next
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end

User-port link aggregation groups (378470)

The GUI now supports the ability to configure user port LAGs on managed FortiSwitches.

To create a link aggregation group for FortiSwitch user ports:

1. Go toWiFi & Switch Controller > FortiSwitch Ports
2. ClickCreate New > Trunk.
3. In the New Trunk Group page:

a. Enter a name for the trunk group
b. Select two or more physical ports to add to the trunk group
c. Select the mode: Static, Passive LACP, or Active LACP

4. ClickOK.

DHCP blocking, STP, and loop guard on managed FortiSwitch ports (375860)

The managed FortiSwitch GUI now supports the ability to enable/disable DHCP blocking, STP and loop guard for
FortiSwitch user ports.

Go to toWiFi & Switch Controller > FortiSwitch Ports. For any port you can select DHCP Blocking, STP, or
Loop Guard. STP is enabled on all ports by default. Loop guard is disabled by default on all ports.

Switch profile enhancements (387398)

Defaults switch profiles are bound to every switch discovered by the FortiGate. This means that an administrator
can establish a password for this profile or create a new profile and bind that profile to any switch. Consquently,
the password provided shall be configured on the FortiSwitch against the default "admin" account already
present.

Number of switches per FortiGate based on model (388024)

The maximum number of supported FortiSwitches depends on the FortiGate model:

FortiGate Model Range Number of FortiSwitches Supported

Up to FortiGate-98 and FortiGate-VM01 8

FortiGate-100 to 280 and FortiGate-VM02 24

FortiGate-300 to 5xx 48

FortiGate-600 to 900 and FortiGate-VM04 64

FortiGate-1000 and up 128

FortiGate-3xxx and up, and FortiGate-VM08 and up 256

Miscellaneous configuration option changes

l The default value of dhcp-snooping (also called DHCP-blocking) is changed from trusted in FortiOS 5.4 to
untrusted in FortiOS 5.6.
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l The default value of edge-port is changed from disabled in FortiOS 5.4 to enabled in FortiOS 5.6.0.
l The default value for DHCP snooping on the FortiLink VLAN (system interface) is changed from “enabled” in

FortiOS 5.6.2 and earlier to “disabled” in FortiOS 5.6.3 and later. Note that, in the GUI, DHCP snooping is
automatically changed to “enable” when the DHCP server is enabled on the interface.

Additional GUI support

l Link aggregation of FortiSwitch ports
l DHCP trusted/untrusted, loop guard, and STP for FortiSwitch ports
l Connect to CLI support for FortiSwitch

FortiView (5.6.3)
New FortiView features added to FortiOS 5.6.3.

Support learning reports and FortiAnalyzer (415806)

Both backend and GUI have been updated to support learning reports from FortiAnalyzer.

Backend updates the query configure list; GUI updates learning report to use log display device setting.

Added support to FortiView to sort by application risk and browsing time (249666)

Added ability to sort applications by threat level and by browsing time so that admin can quickly see and prioritize
the riskier applications at the top of the list.

FortiView (5.6.1)
New FortiView features added to FortiOS 5.6.1.

FortiView Dashboard Widget (434179)

A new widget type has been added to the FortiGate Dashboard, that displays compact FortiView data. Supported
FortiViews include Source, Destination, Application, Country, Interfaces, Policy, Wifi Client, Traffic Shaper,
Endpoint Vulnerability, Cloud User, Threats, VPN, Websites, Admin, and System. All usual visualizations are
supported.

Widgets can be saved directly to the Dashboard from a filtered page in FortiView, or configured in the CLI.

Interface Categories (srcintfrole, etc) added to log data (434188)

In 5.6, logs and FortiView both sort log traffic into two interface categories: "Traffic from LAN/DMZ", and "Traffic
from WAN." For greater compatibility and troubleshooting of FortiAnalyzer and FortiCloud setups, interface
category fields that expose this information have been added to general log data in 5.6.1: srcintfrole and
dstintfrole for better backend control and monitoring.

FortiView (5.6)
New FortiView features added to FortiOS 5.6.
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Added Vulnerability score topology view (303786)

In Physical Topology and Logical Topology pages, there are two new views added: Vulnerability, and
Threat. Drill-downs in these menus will now include Vulnerability/Threat information. In Vulnerability view, device
bubbles are colored based on maximum vulnerability level, and bubble size is the vulnerability score. In Threat
view, device bubbles are colored based on maximum threat level, and bubble size is the threat score.

FortiView VPN tunnel map feature (382767)

The FortiView VPN page now displays VPN tunnel connections between devices, and offers more information
about tunnels and devices on drill-down.

Updated FortiView CSF topology pages (384188)

The FortiView Physical Topology and Logical Topology pages have been updated in 5.6.0 to reorganize and
clarify larger deployments with servers and multi-directional traffic.

Historical FortiView includes FortiAnalyzer (387423)

Data from associated FortiAnalyzer devices can now be selected as a log display option for Historical FortiView.

FortiView menu reorganization (399713)

The order of FortiView pages has been reorganized in 5.6.0 based on the source interface of data being
displayed:

l Topology
l Traffic from LAN/DMZ
l Traffic from WAN
l All Segments

Data Exchange with FortiAnalyzer (393891)

Rather than sending all CSF information via log messages, FortiGate and FortiAnalyzer will now directly pass
CSF information (tree, interface roles, user devices, HA members), if the FAZ responds to notices that are sent
when the data has changed.

Google Maps Integration

FortiView now uses Google Maps to display location-related information. In this release the first view to use
Google maps this component is the FortView VPN page. All current VPNs can be viewed on a fully scalable
Google world map.
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FortiView usability and organization updates (306247)

Several organization changes have been made to make the FortiView menu order less cluttered, and more
intuitive.

l WiFi ClientMonitor is now in FortiView, but is hidden when there is no managed FortiAP or WiFi Radio.
l Country view has been merged into Destinations view.
l Failed Authentication and Admin Login views have been merged into System Events view.
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FortiGate VM enhancements for AWS, Azure, Google, SDN connectors and more (5.6.3)
The realm of virtual computing has become mainstream and not only does this mean that security appliances can
also be virtual, there is also a requirement for security appliances in a virtual environment. These environments
can be the publicly available platforms such as Amazon Web Services, Azure and Google Cloud Platform or they
can be Software Defined Networks (SDN) such as those made by Cisco, HP, Nuage and OpenStack. For that
reason, not only is the number of Virtual FortiOS variations growing along with what they can do, a number of the
new features being introduced deal with integrating FortiOS into these environments.

In some cases the new feature isn't even part of the FortiOS code but a separate piece of software that not only
allows the FortiOS-VM to be part of the virtual environment but allows the management software of the
environment to manage the FortiOS-VM. Previously, these connectors to SDNs have been treated separately as
specialized products with their own documentation. Because they are so integral to FortiOS in a world where
virtual computing is becoming normal, this documentation is going to become more integrated into the normal
FortiOS documentation.

Recipes are now being published for the cloud-based and SDN environments on the Fortinet Cookbook website.

l http://cookbook.fortinet.com/amazon-web-services-aws/
l http://cookbook.fortinet.com/cisco-aci/
l http://cookbook.fortinet.com/microsoft-azure/
l http://cookbook.fortinet.com/nuage-vsp/

FGT_VM64_AZURE and FGT_VM64_AZUREONDEMAND platforms (356702)

FortiOS runs in the Azure Cloud and supports the Azure Security Center NGFW feature. The waagent daemon
is used to configure the VM to communicate with the Azure Cloud fabric.

l The kernel UDF filesystem is needed to mount the cdrom disc on first boot.
l libmxml is upgraded from v2.9 to v2.10

CLI Changes:

Added: azure-security-center logging destination

config log [azure-security-center | azure-security-center2]
config filter

set status [enable | disable]
set appliance-id
set policy-saskey
set policy-name
set eventhub-name
set servicebus-namespace

config setting
set severity (see below)
set forward-traffic [enable | disable]
set local-traffic [enable | disable]
set multicast-traffic [enable | disable]
set sniffer-traffic [enable | disable]
set anomaly [enable | disable]
set voip [enable | disable]
set gtp [enable | disable]
set dns [enable | disable]
set filter (see below)
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set filter-type [include | exclude]

severity option includes the following levels of severity notifications:

l emergency
l alert
l critical
l error
l warning
l notification
l information
l debug

The filter option is set by included the logid list and/or its level as filters. Possibilities include:

l logid(...)
l traffic-level(...)
l event-level(...)
l virus-level(...)
l webfilter-level(...)
l ips-level(...)
l emailfilter-level(...)
l anomaly-level(...)
l voip-level(...)
l dlp-level(...)
l app-ctrl-level(...)
l waf-level(...)
l gtp-level(...)
l dns-level(...)

Example 1

config log azure-security-center
config setting

set filter "logid(40704,32042)"

Example 2

config log azure-security-center
config setting

set filter "event-level(information)"

The available levels are as the following: emergency, alert, critical, error, warning, notice, information,
debugdebug

SDN Connector (404907)

FortiOS-VM is now supported in a Cisco ACI environment through the use of a SDN connector. The software can
be found on the Fortinet Service and Support site.
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FortiGate-VM performance improvements and optimization (416548)

Performance has been improved for FortiOS VM platforms by implementing new features to improve efficiency
and resource utilization. As well, you can now configure interrupt affinity and packet distribution to optimize
performance for your VM environment. Interrupt affinity allows you to align interrupts from interfaces to specific
CPUs. Packet distribution allows you to configure FortiGate-VM to distribute processing to multiple CPUs.

Configuring interrupt affinity

Use the following commands to configure interrupt affinity for two 10G interfaces (port2 and port3).

Interrupts from first interface are assigned to core #0 and those from the second interface are assigned to core
#1.

config system affinity-interrupt
edit 1

set interrupt "port2-TxRx-0"
set affinity-cpumask "0x1"

next
edit 2

set interrupt "port2-TxRx-1"
set affinity-cpumask "0x1"

next
edit 3

set interrupt "port3-TxRx-0"
set affinity-cpumask "0x2"

next
edit 4

set interrupt "port3-TxRx-1"
set affinity-cpumask "0x2"

end

Configuring packet distribution

Use the following commands to configure packet redistribution to redistribute packets from core #0 and #1 to all
other cores.

The example is based on VM08:

config system affinity-packet-redistribution
edit 1

set interface "port2"
set affinity-cpumask "0xFC"

next
edit 2

set interface "port3"
set affinity-cpumask "0xFC"

end

FortiGate-VM Models available for Google Cloud Platform (GCP) (422209)

The following FortiGate-VM models will be supported on Google Cloud Platform:

l FG-VM01
l FG-VM02
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l FG-VM04
l FG-VM08

FG-WM00 is not supported.

Since GCP use netmask 32, static route must be configured on GCP VPC, instead of FGT.

Licenses will be interchangeable between platforms. A FG-VM04 license that functions in a VMware or Citrix
environment can be also used in the GCP environment as well.

While an .out file will be necessary for upgrading, full downloadable images will not be needed for initial
installation of the solution. GCP consists of pre-existing images that can be checked out of their library and
deployed instantly. A difference between this environment and enterprise virtualization platforms is that machine
size can never change. An n1-standard-4 has exactly 15 GB of RAM and 4 vCPUs. This can never be changed or
edited by the end user or administrator.

The currently available GCP instances we are looking to support are as follows (these will/could change as vNIC
values reveal themselves):

FG-VM Equates to Instance Type vCPU RAM Disks

FG-VM01-GC n1-standard-1 1 3.75GB 16 (32 in Beta)

FG-VM02-GC n1-standard-2 2 7.50 GB 16 (64 in Beta)

FG-VM04-GC n1-standard-4 4 15 GB 16 (64 in Beta)

FG-VM08-GC n1-standard-8 8 30 GB 16 (128 in Beta)

FG-VM16-GC n1-standard-16 16 60 GB 16 (128 in Beta)

FG-VM32-GC n1-standard-32 32 88 GB 16 (128 in Beta)

FG-VMUL-GC any of the above and any new that could be created.

Additional information from GCP: https://cloud.google.com/compute/docs/images/building-custom-os.

NPU KVM image for FortiHypervisor (435326)

Currently, there are 2 separate images of FortiOS that can run on FortiHypervisor:

1. Standard KVM image -- this is the one all customers have access to via the Fortinet Support site and FortiGuard
2. NPU support image -- this is a special branch, not available on support site or FortiGaurd.
When FHV tries to deploy a VM that it gets from FortiGuard, it can only retrieve #1 but not #2. NPU versions are
now supported by and available for FortiHypervisor.

FGT-VM AWS HA support (445721)

FortiGate-VMs in an an Amazon Web Services environment support the use of HA.

This includes two parts:
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1. HAwith unicast heartbeat traffic.
2. AWSAPI supports to move secondary IPs and update routing tables.
CLI Changes:

Add:Unicast HA config

config system ha
unicast-hb [enable|disable]
unicast-hb-peerip <Unicast Heartbeat Peer IP>
end

Closed-Network FGT-VM (451872) (455174)

FortiGate-VM is not part of the FortiGuard Network for the purpose of upgrades.

Logging enhancements on FG-VMX (452701)

An event log is created when the Service Manager loses connectivity to a VMX instance. A unique serial number
should be used for each VMX instance so that users can identify from the log which VMX instance is described.

SDN Connector - AWS (454233)

Improvements have been made in the support of FortiGate-VM integrating into the AWS environment.

1. config aws setting has been moved to the context of config system sdn-connector.
config system sdn-connector

edit <string>
set access-key <AWS access key ID>
set secret-key <AWS secret access key>
set region <AWS region name>
set vpc-id <AWS VPC ID>
end

2. Update to the GUI SDN connector edit page that supports allowing configuration of the following fields:
l AWS access key ID
l AWS secret access key
l AWS region name
l AWSVPC ID
l Update Interval

3. Change to address edit page to allow configuration of the Filter field for Dynamic AWS address.
4. Update to the dynamic address monitor API to get resolved address list for dynamic AWS addresses.

NSX Connector Upgrade Support (454674) (458180)

Support for NSX connector upgrade to SDN connectors.

Change to config system sdn-connector:

config nsx setting

Change to config firewall address:

set type nsx

set type dynamic
set sdn nsx
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When using the sdn nsx setting, the user should also use the nsx rest-api
password.

GUI fixes for the SDN Connector (458183) (459079) (459081)

l Update address list and policy list to show icon/tooltip of the dynamic address, the same way as FQDN address
does.

Updates to SDN connector page

l Add back the Enable Service button from SVM Settings page (SVM only)
l Add backVMX Statistics list from SVM Settings page (SVM only)
l Add back api monitor for nsx service (SVM only)
l Remove SVM Settings page

Updates to Address List page

l Disable clone context menu for dynamic sdn address
l Add dynamic address details in colored labels
l Add tool-tip to name column; show invalid icon for unresolved dynamic address (the same way as FQDN address)

Update Policy List page

l add tool-tip to name column; show invalid icon for unresolved dynamic address (the same way as FQDN address)

FortiGate VM (5.6.0)
New Virtual FortiOS features added to FortiOS 5.6.0.

FGT-VM VCPUs (308297)

Fortinet has now launched licensing for FortiGate VMs that support larger than 8 vCPUs. The new
models/licenses include:

l Support for up to 16 vCPU - FortiGate-VM16
l Support for up to 32 vCPU - FortiGate-VM32
l Support for unlimited vCPU - FortiGate-VMUL

Each of these models should be able to support up to 500 VDOMs.

Improvements to License page (382128)

The page has been rewritten with some minor improvements such as:

l An indicator to show when a VM is waiting for authentication or starting up
l Shows VM status when license is valid
l Shows CLI console window when VM is waiting too long for remote registration of server

Citrix XenServer tools support for XenServer VMs (387984)

This support allows users, with Citrix XenServer tools to read performance statistics from XenServer clients and
do Xenmotion with servers in the same cluster
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Since FortiGates don't support hardware hotplugging, the ability to do network
interface of disk changes is not supported at this time.

There are no changes to the GUI, but there are some changes to the CLI.

A setting has been edited to control the debug level of the XenServer tools daemon

diag debug application xstoolsd <integer>

Integer = Debug level

An additional update has been added to set the update frequency for XenServer tools

config system global
set xstools-update-frequency Xenserver <integer>
end

Enter an integer value from 30 to 300 (default = 60).

FOS VM supports more interfaces (393068)

The number of virtual interfaces that the VM version of FortiOS supports has been raised from 3 to 10.

NSX security group importing (403975)

A feature has been added to allow the importation of security group information from VMware's NSX firewall.

CLI Changes:

nsx group list

This is used to list NSX security Groups

Syntax:

execute nsx group list <name of the filter>

nsx group import

This is used to import NSX security groups.

Syntax:

execute nsx group import <vdom> <name of the filter>

nsx group delete

This is used to delete NSX security Groups

Syntax:

execute nsx group delete <vdom> <name of the filter>
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nsx.setting.update-period

This is used to set the update period for the NSX security group

Syntax:

config.nsx.setting.update-period <0 - 3600 in seconds>

0 means disabled

Default value: 0

Non-vdom VM models FGVM1V/FGVM2V/FGVM4V (405549)

Newmodels of the FortiGate-VM have been introduced. These match up with the existing FortiGate-VM models
of FG-VM01, FG-VM02 and FG-VM04. The difference being that the new models don't support VDOMs.

Original FortiGate-VM New FortiGate-VM without VDOM support

FG-VM01 FG-VM01v

FG-VM02 FG-VM02v

FG-VM04 FG-VM04v
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Hardware acceleration (5.6.3)
New hardware acceleration features added to FortiOS 5.6.3.

Bandwidth control between the ISF and NP6 XAUI ports (437911)

In some cases, the Internal Switch Fabric (ISF) buffer size may be larger than the buffer size of an NP6 XAUI port
that receives traffic from the ISF. If this happens, burst traffic from the ISF may exceed the capacity of an XAUI
port and sessions may be dropped.

You can use the following command to configure bandwidth control between the ISF and XAUI ports. Enabling
bandwidth control can smooth burst traffic and keep the XAUI ports from getting overwhelmed and dropping
sessions.

Use the following command to enable bandwidth control:

config system npu
set sw-np-bandwidth {0G | 2G | 4G | 5G | 6G}

end

The default setting is 0G which means no bandwidth control. The other options limit the bandwidth to 2Gbps,
4Gbps and so on.

SNMP/CLI monitoring capabilities of NP6 session table and session drift (441532)

In some cases sessions processed by NP6 processors may fail to be deleted leading to a large number of idle
sessions. This is called session drift. New monitoring capabilities have been added to allow you to use SNMP to
be alerted when the number of idle sessions becomes high. The SNMP fields allow you to see which NP6
processor has the abnormal number of idle sessions and you can use a diagnose command to delete them.

You can use the following diagnose command to determine of drift is occurring:

diagnose npu np6 sse-drift-summary
NPU drv-drift
----- ---------
np6_0 0
np6_1 0
----- ---------
Sum 0
----- ---------

The command output shows a drift summary for all the NP6 processors in the system, and shows the total drift.
Normally the sum is 0. The previous command output, from a FortiGate-1500D, shows that the 1500D's two NP6
processors are not experiencing any drift.

If the sum is not zero, then extra idle sessions may be accumulating. You can use the following command to
delete those sessions:

diagnose npu np6 sse-purge-drift <np6_id> [<time>]

Where <np6_id> is the number (starting with NP6_0 with a np6_id of 0) of the NP6 processor for which to delete
idle sessions. <time> is the age in seconds of the idle sessions to be deleted. All idle sessions this age and older
are deleted. The default time is 300 seconds.

The diagnose npu np6 sse-stats <np6_id> command output also includes a drv-drift field that
shows the total drift for one NP6 processor.
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For SNMPmonitoring, the following MIB fields have been added. These fields allow you to use SNMP to monitor
more session table information for NP6 processors including drift for each NP6 processor.

FORTINET-FORTIGATE-MIB::fgNPUNumber.0 = INTEGER: 2
FORTINET-FORTIGATE-MIB::fgNPUName.0 = STRING: NP6
FORTINET-FORTIGATE-MIB::fgNPUDrvDriftSum.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUIndex.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUIndex.1 = INTEGER: 1
FORTINET-FORTIGATE-MIB::fgNPUSessionTblSize.0 = Gauge32: 33554432
FORTINET-FORTIGATE-MIB::fgNPUSessionTblSize.1 = Gauge32: 33554432
FORTINET-FORTIGATE-MIB::fgNPUSessionCount.0 = Gauge32: 0
FORTINET-FORTIGATE-MIB::fgNPUSessionCount.1 = Gauge32: 0
FORTINET-FORTIGATE-MIB::fgNPUDrvDrift.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUDrvDrift.1 = INTEGER: 0

Hardware acceleration (5.6.1)
New hardware acceleration features added to FortiOS 5.6.1.

Optionally disable NP6 offloading of traffic passing between 10Gbps and 1Gbps interfaces
(392436)

Due to NP6 internal packet buffer limitations, some offloaded packets received at a 10Gbps interface and
destined for a 1Gbps interface can be dropped, reducing performance for TCP and IP tunnel traffic. If you
experience this performance reduction, you can use the following command to disable offloading sessions
passing from 10Gbps interfaces to 1Gbps interfaces:

config system npu
set host-shortcut-mode host-shortcut

end

Select host-shortcut to stop offloading TCP and IP tunnel packets passing from 10Gbps interfaces to 1Gbps
interfaces. TCP and IP tunnel packets passing from 1Gbps interfaces to 10Gbps interfaces are still offloaded as
normal.

If host-shortcut is set to the default bi-directional setting, packets in both directions are offloaded.

Hardware acceleration (5.6)
New hardware acceleration features added to FortiOS 5.6.

Improved visibility of SPU and nTurbo hardware acceleration (389711)

All hardware acceleration hardware has been renamed Security Processing Units (SPUs). This includes NPx and
CPx processors.

SPU and nTurbo data is now visible in a number of places on the GUI. For example, the Active Sessions column
pop-up in the firewall policy list and the Sessions dashboard widget.

The following example shows the Sessions dashboard widget tracking SPU and nTurbo sessions. Current
sessions shows the total number of sessions, SPU shows the percentage of these sessions that are SPU
sessions and Nturbo shows the percentage that are nTurbo sessions.
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You can also add SPU filters to many FortiView pages.

NP4Lite option to disable offloading ICMP traffic in IPsec tunnels (383939)

In some cases ICMP traffic in IPsec VPN tunnels may be dropped by the NP4Lite processor due to a bug with the
NP4Lite firmware. You can use the following command to avoid this problem by preventing the NP4Lite processor
from offloading ICMP sessions in IPsec VPN tunnels. This command is only available on FortiGate models with
NP4Lite processors, such as the FortiGate/FortiWiFi-60D.

config system npu
set process-icmp-by-host {disable | enable}

end

The option is disabled by default an all ICMP traffic in IPsec VPN tunnels is offloaded where possible. If you are
noticing that ICMP packets in IPsec VPN tunnels are being dropped you can disable this option and have all ICMP
traffic processed by the CPU and not offloaded to the NP4Lite.

NP6 IPv4 invalid checksum anomaly checking (387675)

The following new options have been added to NP6 processors to check for IPv4 checksum errors in IPv4, TCP,
UDP, and ICMP packets.

config system np6
edit {np6_0 | np6_1| ...}

config fp-anomaly
set ipv4-csum-err {drop | trap-to-host}
set tcp-csum-err {drop | trap-to-host}
set udp-csum-err {drop | trap-to-host}
set icmp-csum-err {drop | trap-to-host}

end

You can use the new options to either drop packets with checksum errors (the default) or send them to the CPU
for processing. Normally you would want to drop these packets.

As well, note that when configuring NP6 anomaly protection, the separate options config fp-anomaly-v4
and config fp-anomaly-v6 have been combined under config fp-anomaly.
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Stripping clear text padding and IPsec session ESP padding (416950)

In some situations, when clear text or ESP packets in IPsec sessions may have large amounts of layer 2 padding,
the NP6 IPsec engine may not be able to process them and the session may be blocked.

If you notice dropped IPsec sessions, you could try using the following CLI options to cause the NP6 processor to
strip clear text padding and ESP padding before sending the packets to the IPsec engine. With padding stripped,
the session can be processed normally by the IPsec engine.

Use the following command to strip ESP padding:

config system npu
set strip-esp-padding enable
set strip-clear-text-padding enable

end

Stripping clear text and ESP padding are both disabled by default.
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High Availability (5.6.1)
New High Availability features added to FortiOS 5.6.1.

HA cluster Uptime on HA Status dashboard widget (412089)

The HA Status dashboard widget now displays how long the cluster has been operating (Uptime) and the time
since the last failover occurred (State Changed). You can hover over the State Changed time to see the event
that caused the state change.

You can also click on the HA Status dashboard widget to configure HA settings or to get a listing of the most
recent HA events recorded by the cluster.

FGSP with static (non-dialup) IPsec VPN tunnels and controlling IKE routing advertisement
(402295)

Until FortiOS 5.6.1, the FortiGate Session Life Support Protocol (FGSP) only supported IPsec tunnel
synchronization for dialup (or dynamic) IPsec VPN tunnels. FortiOS 5.6.1 now also supports IPsec tunnel
synchronization for static IPsec VPN tunnels. No special FGSP or IPsec VPN configuration is required. You can
configure static IPsec VPN tunnels normally and create a normal FGSP configuration.

An additional feature has been added to support some FGSP configurations that include IPsec VPNs. A new CLI
option allows you to control whether IKE routes are synchronized to all units in the FGSP cluster.

config system cluster-sync
edit 0

set slave-add-ike-routes {enable | disable}
end

Enable to synchronize IKE routes, disable if you do not need to synchronize IKE routes. Enabling routing
synchronization is optional but doing so increases synchronization overhead and bandwidth usage. If you have
problems with IPsec VPN tunnel synchronization you may want to enable synchronizing routes otherwise you
could leave it disabled to improve performance and save bandwidth.
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VRRP support for synchronizing firewall VIPs and IP Pools (0397824)

FortiOS VRRPHA now supports failover of firewall VIPs and IP Pools when the status of a virtual router (VR)
changes. This feature introduces a new proxy ARP setting to map VIP and IP Pool address ranges to each VR's
Virtual MAC (VMAC). After failover, the IP Ranges added to the new primary VR will be routed to the new primary
VR`s VMAC.

Use the following command to add a proxy ARP address range and a single IP address to a VR added to a
FortiGate`s port5 interface. The address range and single IP address should match the address range or single IP
for VIPs or IP Pools added to the port5 interface:

config system interface
edit port5

config vrrp
edit 1

config proxy-arp
edit 1

set ip 192.168.62.100-192.168.62.200
next
edit 2

set ip 192.168.62.225
end

High Availability (5.6)
New High Availability features added to FortiOS 5.6.

Multicast session failover (293751)

FGCPHAmulticast session synchronization supports multicast session failover. To configure multicast session
failover, use the following command to change the multicast TTL timer to a smaller value than the default. The
recommended setting to support multicast session failover is 120 seconds (2 minutes). The default setting is 600
seconds (10 minutes).

config system ha
set multicast-ttl 120

end

The multicast TTL timer controls how long to keep synchronized multicast routes on the backup unit (so they are
present on the backup unit when it becomes the new primary unit after a failover). If you set the multicast TTL
lower the multicast routes on the backup unit are refreshed more often so are more likely to be accurate.
Reducing this time causes route synchronization to happen more often and could affect performance.

Performance improvement when shutting down or rebooting the primary unit (380279)

In previous versions of FortiOS, if you entered the execute reboot or execute shutdown command on
the primary unit, a split brain configuration could develop for a few seconds while the primary unit was shutting
down. This would happen because the heartbeat packets would stop being sent by the primary unit, while it was
still able to forward traffic. When the heartbeat packets stop the backup unit becomes the primary unit. The result
was a split brain configuration with two primary units both capable of forwarding traffic.

This wouldn't happen all the time, but when it did network traffic would be delayed until the primary unit shut
down completely. To resolve this issue, in FortiOS 5.6 when you run the execute reboot or execute
shutdown command on the primary unit, the primary unit first becomes the backup unit before shutting down
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allowing the backup unit to become the new primary unit and avoiding the split brain scenario. This behavior only
happens when you manually run the execute reboot or execute shutdown command from the primary
unit.

VRRP failover process change (390938)

In a FortiOS 5.6 VRRP configuration, when the master cannot reach its next hop router (vrdst) it sends packets to
the configured backup router(s). These packets set the priority of the master to be lower than the backup router
(s). So a backup router now becomes the new master and takes over processing traffic.

Use the vrdst-priority option to set the lower priority that the master sends to the backup routers. The
following CLI syntax resets the master's priority to 10 if it can no longer connect to its next hop router.

config system interface
edit port10

config vrrp
set vrip 10.31.101.200
set priority 255
set vrdst 10.10.10.1
set vrdst-priority 10

end

Display cluster up time and history (get system ha status command changes)(394745)

The get system HA status command now displays cluster uptime and history:

get system status
Version: FortiGate-5001D v5.6.0,build1413,170121 (interim)
...
Current HA mode: a-p, master
Cluster uptime: 3 days, 4 hours, 3 minutes, 46 seconds
...

In-band HA management Interface (401378)

You can use the following command to add a management interface to an individual cluster unit interface that is
also connected to a network and processing traffic. The in-band management interface is an alternative to the
reserved HAmanagement interface feature and does not require reserving an interface just for management
access.

config system interface
edit port1

set management-ip 172.20.121.155/24
end

The management IP address is accessible from the network that the cluster interface is connected to. This
setting is not synchronized so each cluster unit can have their own management IP addresses. You can add a
management IP address to each cluster unit interface. You can use the execute ha manage command to
connect to individual cluster units.

The management-ip can be on the same subnet as the interface you are adding it to but cannot be on the
same subnet as other cluster unit interfaces.

Up to four dedicated HA management interfaces supported (378127)

You can now add up to four dedicated HAmanagement interfaces. Just like all FortiGate interfaces, these
management interfaces must be on a different subnet from any other FortiGate interface. You can also configure
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a separate default gateway for each interface.

Use the following command to add two dedicated HAmanagement interfaces:

config system ha
set ha-mgmt-status enable

config ha-mgmt-interfaces
edit 1

set interface port4
set gateway 10.10.10.1

next
edit 2

set interface port5
set gateway 4.5.6.7

end

FGSP support for automatic session sync after peer reboot (365851)

New options allow you to configure your FGSP cluster to resume sessions more smoothly after a failed FortiGate
rejoins the cluster. In some cases when a failed FortiGate in the cluster comes back up it may begin processing
sessions before the session table has been synchronized to it from the other FortiGate in the cluster. When this
happens, the FortiGate may drop packets until the session synchronization is complete.

Shutting down interfaces during session synchronization

This new feature allows you to shut some interfaces down on the failed FortiGate when it is starting up so that it
will not accept packets until session synchronization is complete. Then the interfaces are brought up and traffic
can flow. While the interfaces are down, the FortiGate that had not failed keeps processing traffic.

Use the following command to select the interfaces to shutdown while waiting for session synchronization to
complete:

config system cluster-sync
edit 1

set down-intfs-before-sess-sync port1 port2
end

Heartbeat monitoring

If the FortiGate that was running fails before session synchronization is complete, the FortiGate that is restarting
would not be able to complete session synchronization and would not turn on its shutdown interfaces. To prevent
this from happening FGSP now includes heartbeat monitoring. Using heartbeat monitoring the FortiGate that is
waiting for session synchronization to finish can detect that the other FortiGate is down and turn on its interfaces
even if session synchronization is not complete. You can use the following command to change the heartbeat
interval (hb-interval) and lost heartbeat threshold (hp-lost-threshold) to change heartbeat monitoring
timing.

config system cluster-sync
edit 1

set hb-interval 2
set hb-lost-threshold 3

end
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NTP over Dedicated HA management interfaces (397889)

If you set up dedicated management interfaces on each cluster unit, if NTP is enabled, the primary unit contacts
an NTP server using the dedicated management interface. System time is then synchronized to the backup units
through the HA heartbeat.

Example CLI:

config system interface
edit port5

set ip 172.16.79.46 255.255.255.0
end

config system ha
set group-name FGT-HA
set mode a-p
set ha-mgmt-status enable

config ha-mgmt-interfaces
edit 1

set interface port5
set gateway 172.16.79.1

end
set ha-direct enable

end

config system ntp
set ntpsync enable
set syncinterval 5

end
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IPsec VPN (5.6.3)
New IPsec VPN features added to FortiOS 5.6.3.

IPsec performance improvements for VM (439030)

In IPsec AES-GCM and AES-CBC-SHAmode, this feature leverages Intel AES-NI instructions to accelerate
cipher and GCM operations, and uses Intel SSSE3 instructions to accelerate SHA1/SHA256 HMAC operations.

New entries to call Intel aesni directly:

l supported algorithms include: aesni, aesni-gcm, sha1/256/384/512-ssse3/avx/avx2
l some necessary additions, such as aes-gcm generic functions for non-aesni uses

This feature removes the old aes-gcm implementation using Linux Crypto API so that all the software crypto
algorithms are under the Crypto_ftnt umbrella.

Two new diagnose commands have been introduced in this feature:

diagnose vpn ipsec driver   (shows software crypto drivers in use)
diagnose vpn ipsec cpu (shows crypto CPU distribution)

Improved support for dynamic routing over dynamic IPsec interfaces (435152) (446498)
(447569)

Solutions have been introduced to resolve the following issues:

l IPv6 RIP does not successfully exchange routes over ADVPN if the hub has 'set net-device disable'.
l BGP over an IPsec tunnel established by an IKEmode-cfg client connected to IKEmode-cfg server with 'set net-

device disable' cannot establish.
l Multicast traffic does not flow over a 'set type dynamic' IPsec interface with 'set net-device disable'.

For 'set type dynamic' + 'set net-device disable' + 'set mode-cfg enable' + 'set add-route disable' then do _not_
allocate a /30 (/126 for IPv6) as is done when 'set net-device enable', instead allocate a single IP address to the
peer.

When the 'set type dynamic' tunnel negotiates, then add an IPsec peer route with the peer's allocated IP address
pointing at the newly negotiated tunnel. Note this is an IPsec peer route not a regular route. A regular route is not
added (unlike the case of 'set net-device enable').

'Config router static' / 'set device xxx' can now refer to a 'set type dynamic' IPsec interface. This allows the admin
to define a static route covering the address range of the pool from which peer IP addresses will be allocated.

BMRK IPsec UDP performance for AES256GCM drops after AES-NI checked in (452164)

This new feature fixes the aesni-cbc errors and precomputed the per-SA constant elements for aesni-gcm.

1. aesni-cbc
When ECO 106922 was checked in, there was a known issue that the aesni-cbc driver wasn't working. The
solution at that time was aesni plus generic cbc.

With this ECO, we fixed the errors in Intel's aesni-cbc driver so that we can fully leverage the aesni-cbc
benefits. The aesni-cbc is faster than aesni plus generic cbc because:
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a. it can do cbc in one go with its 128-bits xmm registers.

b. it can decrypt 4 blocks at the same time instead of one. It uses alternating AESDEC(Intel's aes instruction) on
different blocks to speed up the calculations.

QA's tests show that with this, we can boost aes-cbc-sha1's throughput by 10+%.

2. AES fall-back function changed to Intel's x86_64 assembly from C generic function
When fpu is not available, aesni can't be used and must fall back to a generic function. The assembly aes
function should be slightly faster than the C generic one.

This would also slight boost aes throughput for those that don't have aesni but have a x86_64 cpus.

3. aesni-gcm pre-computions
There are some elements in the aesni-gcm algo that maintain constant per-SA. This ECO moves these
calculations to the prepare() function so that these calculations are only done once per-SA instead of per-
packet.

QA's tests show that this helps to stabilize the 1500D aesni-gcm throughput and make it maintain above
1Gbps (packet size 1360).

4. Added counter reset function for diagnose commands:
diagnose vpn ipsec driver clear
diagnose vpn ipsec cpu clear

IPsec dial-up interface sharing (379973)

This feature makes it possible to use a single interface for all instances that spawn via a given phase1. Instead of
creating an interface per instance, all traffic will run over the single interface and any routes that need creating will
be created on that single interface.

A new CLI option "net-device [enable|disable]" is added in the phase1-interface command sets. The
default is "disable" so that the new feature kicks in for all the new configurations. An upgrade feature will add a
"set net-device enable" for all the existing configurations so that they will keep the old behavior. Please see the
CLI Syntax section below for more details.

Under the new single-interface scheme, instead of relying on routing to guide traffic to the specific instance as
currently happens, all traffic will flow to the specific device and IPsec will need to take care of locating the correct
instance for outbound traffic. For this purpose, another new CLI option "tunnel-search" is created. The option is
only available when the above "net-device" option is "disable".

There are two options for "tunnel-search", corresponding to the two ways to select the tunnel for outbound traffic.
One is "selectors", meaning selecting a peer using the IPSec selectors (proxy-ids). The other is "nexthop" where
all the peers use the same default selectors (0/0) while using some routing protocols such as BGP, OSPF, RIPng,
etc to resolve the routing. The default for "tunnel-search" is "selectors".

Syntax

config vpn ipsec phase1-interface
edit xxx

set net-device [enable|disable] Enable to create a kernel device for every dialup instance
next

end
config vpn ipsec phase1-interface

edit xxx
set net-device disable
set tunnel-search [selectors|nexthop] Search for tunnel in selectors or using nexthops
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next
end

IPsec VPN (5.6.1)
New IPsec VPN features added to FortiOS 5.6.1.

Support for Brainpool curves specified in RFC 6954 for IKE (412795)

Added support for Brainpool curves specified in RFC 6954 (originally RFC 5639) for IKE. Four new values are
added for VPN phase1 and phase2 DH groups.

The allocated transform IDs are 27, 28, 29, 30:

l 27 - Brainpool 224-Bit Curve
l 28 - Brainpool 256-Bit Curve
l 29 - Brainpool 384-Bit Curve
l 30 - Brainpool 512-Bit Curve

Syntax

config vpn ipsec phase1/phase1-interface
edit <name>

set dhgrp {1 | 2 | 5 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 27 | 28 | 29 | 30}
next

end
config vpn ipsec phase2/phase2-interface

edit <name>
set dhgrp {1 | 2 | 5 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 27 | 28 | 29 | 30}

next
end

Removed "exchange-interface-ip" option from "vpn ipsec phase1" (411981)

The command exchange-interface-ip only works for interface-based IPsec VPN (vpn ipsec phase1-
interface), and so it has been removed from policy-based IPsec VPN (vpn ipsec phase1).

IKEv2 ancillary RADIUS group authentication (406497)

This feature provides for the IDi information to be extracted from the IKEv2 AUTH exchange and sent to a
RADIUS server, along with a fixed password configurable via CLI, to perform an additional group authentication
step prior to tunnel establishment. The RADIUS server may return framed-IP-address, framed-ip-netmask, and
dns-server attributes, which are then applied to the tunnel.

It should be noted, unlike Xauth or EAP, this feature does not perform individual user authentication, but rather
treats all users on the gateway as a single group, and authenticates that group with RADIUS using a fixed
password. This feature also works with RADIUS accounting, including the phase1 acct-verify option.

Syntax

config vpn ipsec phase1-interface
edit <name>

set mode-cfg enable
set type dynamic
set ike-version 2
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set group-authentication {enable | disable}
set group-authentication-secret <password>

next
end

IPsec mode-cfg can assign IPs from firewall address and sharing IP pools (393331)

This feature adds the ability for users to configure assign-IPs from firewall addresses/groups.

Previously, different policies accessing the same network needed to ensure that non-overlapping IP-ranges were
assigned to policies to avoid the same IP address being assigned to multiple clients. With this feature, the
address name is used to identify an IP pool and different policies can refer to the same IP pool to check for
available IPs, thus simplifying the task of avoiding IP conflicts.

Syntax

config vpn ipsec phase1-interface
edit <name>

set mode-cfg enable
set type dynamic
set assign-ip-from {range | dhcp | name}
set ipv4-name <name>
set ipv6-name <name>

next
end

Improve interface-based dynamic IPsec up/down time (379937)

This feature makes it possible to use a single interface for all instances that spawn via a given phase1. Instead of
creating an interface per instance, all traffic will run over the single interface and any routes that need creating will
be created on that single interface.

A new CLI option net-device is added in the phase1-interface command sets. The default is disable
so that the new feature kicks in for all the new configurations. An upgrade feature will add a set net-device
enable for all the existing configurations so that they will keep the old behavior.

Under the new single-interface scheme, instead of relying on routing to guide traffic to the specific instance, all
traffic will flow to the specific device and IPsec will need to take care of locating the correct instance for outbound
traffic. For this purpose, another new CLI option tunnel-search is created. The option is only available when
the above net-device option is set to disable.

There are two options for tunnel-search, corresponding to the two ways to select the tunnel for outbound
traffic. One is selectors, meaning selecting a peer using the IPsec selectors (proxy-ids). The other is
nexthop where all the peers use the same default selectors (0/0) while using some routing protocols such as
BGP, OSPF, RIPng, etc. to resolve the routing. The default for tunnel-search is selectors.

Syntax

config vpn ipsec phase1-interface
edit <name>

set net-device {enable | disable}
set tunnel-search {selectors | nexthop}

next
end
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Hide psksecret option when peertype is dialup (415480)

In aggressive mode and IKEv2, when peertype is dialup, pre-shared key is per-user based. There is no need to
configure the psksecret in the phase1 setup. Previously, if left unconfigured, CLI would output psksecret error and
fail to create the phase1 profile.

To prevent psksecret length check running on the configuration end, the psksecret option will be hidden. Prior to
Mantis 397712, the length check passed because it was incorrectly checking the legnth of encrypted password
which is always 204 length long.

Peertype dialup option removed for main mode.

New enforce-ipsec option added to L2TP config (423988)

A new enforce-ipsec option is added in L2TP configuration to force the FortiGate L2TP server to accept only
IPsec encrypted connections.

Syntax

config vpn l2tp
set eip 50.0.0.100
set sip 50.0.0.1
set status enable
set enforce-ipsec-interface {disable | enable} (default = disable)
set usrgrp <group_name>

end

IPsec VPN Wizard improvements (368069)

Previously, when using wan-load-balance (WLB) feature, and when configuring an IPsec tunnel with the wizard,
the setting 'incoming interface' list does not contain the wan-load-balance nor the wan2 interface. Disabling the
WLB permits the configuration.

The solution in 5.6.1 is as follows:

l (368069) The IPsec VPN wizard now allows users to select members of virtual-wan-link (VWL) as IPsec phase1-
interface. Before saving, if the phase1 interface is a VWL member, then the Wizard automatically sets the virtual-
wan-link as the destination interface in the L2TP policy.

l (246552) List VPN tunnels for VWL members if VWL is set as the destination interface in policy-based IPsec VPN.

IPsec manual key support removed from GUI (436041)

The majority of customers are not using policy-based IPsec today, and beyond that, very few are using manual
key VPN. As a result, the IPsec manual key feature is removed from the GUI; the feature store option is removed
as well.

Added GUI support for local-gw when configuring custom IPsec tunnels (423786)

Previously, the local-gw option was not available on the GUI when configuring a custom IPsec tunnel. This
feature adds the local-gw setting to the IPsec VPN Edit dialog. The user is able to choose the primary or
secondary IP address from the currently selected interface, or specify an ip address manually. Both local-gw
and local-gw6 are supported.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

207



What's New in previous versions of FortiOS 5.6 Chapter 1 - What's New for FortiOS 5.6

Moved the dn-format CLI option from phase1 config to vdom settings (435542)

Previous fix for dn-format didn't take into account that, at the time isakmp_set_peer_identifier is used, we
don't have a connection and haven't matched our gateway yet, so we can't use that to determine the dn-format
configuration setting.

The solution was to move the dn-format CLI option from phase1 config to vdom settings. It is renamed to
ike-dn-format.

FGT IKE incorrect NAT detection causes ADVPN hub behind VIP to not generate shortcuts
(416786)

When ADVPN NAT support was added, only spokes behind NAT was considered. No thought was given to a hub
behind a VIP or the problems that occurred due to the way that FortiOS clients behind NAT enable NAT-T even
when it is not required.

The solution in 5.6.1 is as follows:

l Moved shortcut determination out of the kernel and up to IKE. The shortcut message now contains the ID of both
tunnels so that IKE can check the NAT condition of both.

l Added IKE debug to cover sending the initial shortcut query. The lack of this previously meant it could be awkard to
determine if the offer had been converted into a query correctly.

l Added "nat:" output in diag vpn ike gateway list output to indicate whether this device or the peer is
behind NAT.

l Tweaked the diag vpn tunnel list output so that the auto-discovery information now includes symbolic
as well as numeric values, which makes it easier to see what type of auto-discovery was enabled.

IPsec VPN (5.6)
New IPsec VPN features added to FortiOS 5.6.

Improvement to stats crypto command output (403995)

The CLI command get vpn ipsec stats crypto now has a better format for the information it shows in
differentiating between NP6 lite and SOC3 (CP). To further avoid confusion, all engine's encryption
(encrypted/decrypted) and integrity (generated/validated) information is shown under the same heading, not
separate headings.

Improved certificate key size control commands (397883)

Proxy will choose the same SSL key size as the HTTPS server. If the key size from the server is 512, the proxy will
choose 1024. If the key size is bigger than 1024, the proxy will choose 2048.

As a result, the firewall ssl-ssh-profile commands certname-rsa, certname-dsa, and
certname-ecdsa have been replaced with more specific key size control commands under vpn
certificate setting.

CLI syntax

config vpn certificate setting
set certname-rsa1024 <name>
set certname-rsa2048 <name>
set certname-dsa1024 <name>
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set certname-dsa2048 <name>
set certname-ecdsa256 <name>
set certname-ecdsa384 <name>

end

Support bit-based keys in IKE (397712)

As per FIPS-CC required standards, as well as RFC 4306, IKE supports pre-shared secrets to be entered as
both ASCII string values and as hexadecimal encoded values. This feature parses hex encoded input (indicated
by the leading characters 0x) and converts the input into binary data for storage.

With this change, the psksecret and psksecret-remote entries under the IPsec VPN CLI command
config vpn ipsec-phase1-interface have been amended to differentiate user input as either ASCII
string or hex encoded values.

IKEv2 asymmetric authentication (393073)

Support added for IKEv2 asymmetric authentication, allowing both sides of an authentication exchange to use
different authentication methods, for example the initiator may be using a shared key, while the responder may
have a public signature key and certificate.

A new command, authmethod-remote, has been added to config vpn ipsec phase1-interface.

For more detailed information on authentication of the IKE SA, see RFC 5996 - Internet Key Exchange Protocol
Version 2 (IKEv2).

Allow mode-cfg with childless IKEv2 (391567)

An issue that prevented childless-ike from being enabled at the same time as mode-cfg has been
resolved. Both options can now be enabled at once under config vpn ipsec phase1-interface.

IKEv2 Digital Signature Authentication support (389001)

FortiOS supports the use of Digital Signature authentication, which changes the format of the Authentication
Data payload in order to support different signature methods.

Instead of just containing a raw signature value calculated as defined in the original IKE RFCs, the Auth Data now
includes an ASN.1 formatted object that provides details on how the signature was calculated, such as the
signature type, hash algorithm, and signature padding method.

For more detailed information on IKEv2 Digital Signature authentication, see RFC 7427 - Signature
Authentication in the Internet Key Exchange Version 2 (IKEv2).

Passive static IPsec VPN (387913)

New commands have been added to config vpn ipsec phase1-interface to prevent initiating
VPN connection. Static IPsec VPNs can be configured in tunnel mode, without initiating tunnel negotiation or
rekey.

To allow a finer configuration of the tunnel, the rekey option is removed from config system global and
added to config vpn ipsec phase1-interface.

CLI syntax

config vpn ipsec phase1-interface
edit <example>
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set rekey {enable | disable}
set passive-mode {enable | disable}
set passive-tunnel-interface {enable | disable}

end

Phase 2 wizard simplified (387725)

Previously, for a site-to-site VPN, phase 2 selectors had their static routes created in the IPsec VPN wizard by
adding IP addresses in string format. Now, since addresses and address groups are already created for these
addresses, the address group can be used in the route directly. This means that the route can be modified simply
by modifying the address/groups that were created when the VPN was initially created.

With this change, the VPN wizard will create less objects internally, and reduce complexity.

In addition, a blackhole route route will be created by default with a higher distance-weight set than the default
route. This is to prevent traffic from flowing out of another route if the VPN interface goes down. In these
instances, the traffic will instead be silently discarded.

Unique IKE ID enforcement (383296)

All IPsec VPN peers now connect with unique IKE identifiers. To implement this, a new phase1 CLI command
has been added (enforce-unique-id) which, when enabled, requires all IPsec VPN clients to use a unique
identifier when connecting.

CLI syntax

config vpn ipsec phase1
edit <name>

set enforce-unique-id {keep-new | keep-old | disable} Default is disable.
next

end

Use keep-new to replace the old connection if an ID collision is detected on the gateway.
Use keep-old to reject the new connection if an ID collision is detected.

FortiView VPN tunnel map feature (382767)

A geospatial map has been added to FortiView to help visualize IPsec and SSL VPN connections to a FortiGate
using Google Maps. Adds geographical-IP API service for resolving spatial locations from IP addresses.

This feature can be found under FortiView > VPN.

Childless IKEv2 initiation (381650)

As documented in RFC 6023, when both sides support the feature, no child IPsec SA is brought up during the
initial AUTH of the IKEv2 negotiation. Support for this mode is not actually negotiated, but the responder
indicates support for it by including a CHILDLESS_IKEV2_SUPPORTED Notify in the initial SA_INIT reply. The
initiator is then free to send its AUTH without any SA or TS payloads if it also supports this extension.

CLI syntax

config vpn ipsec phase1-interface
edit ike

set ike-version 2
set childless-ike enable

next
end
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Due to the way configuration payloads (IKEV2_PAYLOAD_CONFIG) are handled in
the current code base, mode-cfg and childless-ike aren't allowed to be enabled at the
same time. Processing config payloads for mode-cfg requires a child ph2handle to be
created, but with childless-ike we completely avoid creating the child ph2 in the first
place which makes the two features incompatible. It may be possible to support both
in the future, but a deeper rework of the config payload handling is required.

Allow peertype dialup for IKEv2 pre-shared key dynamic phase1 (378714)

Restored peertype dialup that was removed in a previous build (when IKEv2 PSK gateway re-validation was
not yet supported).

If peertype is dialup, IKEv2 AUTH verify uses user password in the user group "usrgrp" of phase1. The
"psksecret" in phase1 is ignored.

CLI syntax

config vpn ipsec phase1-interface
edit "name"

set type dynamic
set interface "wan1"
set ike-version 2
set peertype dialup
set usrgrp "local-group"

next
end

IPsec default phase1/phase1-interface peertype changed from 'any' to 'peer' (376340)

Previously, when authmethod was changed to signature, peertype automatically changed to peer and
required a peer to be set. This change was done to try to provide a more secure initial configuration, while
allowing the admin to set peertype back to any if that's what they really wanted. The default value was kept at
any in the CLI. However, this caused problems with copy/pasting configurations and with FMG because if
peertype any wasn't explicitly provided, the CLI was switched to peertype peer.

This patch changes the default peertype to peer now; peertype any is considered non-default and will be printed
out on any config listing. Upgrade code has been written to ensure that any older build that was implicitly using
set peertype any has this setting preserved.

IPsec GUI bug fixes (374326)

Accept type "Any peer ID" is available when creating IPsec tunnel with authmethod, pre-shared key, ikev1 main
mode/aggressive mode, and ikev2.

Support for IKEv2 Message Fragmentation (371241)

Added support for IKEv2 Message Fragmentation, as described in RFC 7383.

Previously, when sending and IKE packets with IKEv1, the whole packet is sent once, and it is only fragmented if
there is a retransmission. With IKEv2, because RFC 7383 requires each fragment to be individually encrypted
and authenticated, we would have to keep a copy of the unencrypted payloads around for each outgoing packet,
in case the original single packet was never answered and we wanted to retry with fragments. So with this
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implementation, if the IKE payloads are greater than a configured threshold, the IKE packets are preemptively
fragmented and encrypted.

CLI syntax

config vpn ipsec phase1-interface
edit ike

set ike-version 2
set fragmentation [enable|disable]
set fragmentation-mtu [500-16000]

next
end

IPsec monitoring pages now based on phase 1 proposals not phase 2 (304246)

The IPsec monitor, found underMonitor > IPsec Monitor, was in some instances showing random uptimes
even if the tunnel was in fact down.

Tunnels are considered as "up" if at least one phase 2 selector is active. To avoid confusion, when a tunnel is
down, IPsec Monitor will keep the Phase 2 Selectors column, but hide it by default and be replaced with
Phase 1 status column.
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IPv6 (5.6.3)
New IPv6 features added to FortiOS 5.6.3.

IPv6 RADIUS support (402437, 439773)

Added support for IPv6 RADIUS authentication. When configuring the FortiGate interface and the RADIUS server
(under config system interface and config user radius respectively), the server IP address can
be set as IPv6.

Added support for IPv6 Fortisandbox (424290) (447153)

FortiOS can now communicate with a FortiSandbox if the FortiSandbox has an IPv6 IP address.

IPv6 captive portal support (435435)

Captive portal now supports IPv6 addresses; works with remote RADIUS authentication and WiFi interfaces.

IPv6 (5.6)
New IPv6 features added to FortiOS 5.6.

FortiGate can reply to an anycast probe from the interface’s unicast address (308872)

A new setting has been added within the CLI that can enable the FortiGate to reply to an anycast probe from the
FortiGate’s unicast IP address.

config system global
set ipv6-allow-anycast-probe [enable|disable]
end

Enable: Enable probing of IPv6 address space through Anycast, by responding from the unicast IP address

Disable:Disable probing of IPv6 address space through Anycast

Secure Neighbor Discovery (355946)

Additional settings have been added to the configuration for interfaces with IPv6 so that they comply more closely
to the parameters of RFC 3971

The context of the new settings is

config system interface
edit <interface>
config ipv6

The new options with IPv6 are:

ndmode

Neighbor discovery mode

set ndmode [basic | SEND]

Basic: Does not support SEND.
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SEND-compatible: Supports SEND.

nd-cert

Neighbor discovery certificate

set nd-cert <string of Name of certificate to be used>

Example string: "Fortinet_Factory local"

n-security-level

Neighbor discovery security level

set nd-security-level <integer>

l Integer values from 0 - 7
l 0 = least secure
l 7 =most secure
l default = 0

nd-timestamp-delta -

Neighbor discovery timestamp delta value

set nd-timestamp-delta <integer of time in seconds>

l Range: 1 - 3600 sec
l default = 300

nd-timestamp-fuzz

Neighbor discovery timestamp fuzz factor

set nd-timestamp-fuzz <integer of time in seconds>

l Range: 1 - 60 sec
l default = 1

Additional related technical information

Kerenl

l Redirects ICMPv6 packets to user space if they require SEND options verification or build.

Radvd

l Verifies NS/RS SEND options including CGA, RSA, Timestamp, NONCE, etc. Daemon also creates neighbor cache
for future timestamp checking, any entry gets flushed in 4 hours.

l Helps kernel build NA/RA SEND options including CGA, RSA, Timestamp, NONCE, etc. CGA parameters are kept
in cache for each interface. CGAmodifier is kept in CMDB.
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Diagnose command for radvd

diag test application radvd

l Shows statistics
l Toggles message dump

Add multicast-PMTU to allow FGT to send ICMPv6 Too Big Message (373396)

Newmulticast-PMTU feature added to better comply with RFC 4443.

Normally, a “Packet Too Big” icmp6 message is sent by a routing device in response to a packet that it cannot
forward because the packet is larger than the MTU of the outgoing link. For security reasons, these message may
be disabled because attackers can use the information about a victim's ip address as the source address to do IP
address spoofing.

In FortiOS’s implementation of this function, a setting in the CLI, has been added to make this behavior optional
on the FortiGate.

The syntax for the option is:

config router multicast6
set multicast-PMTU [enable|disable]
end
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Logging and Reporting (5.6.3)
New logging and reporting features added to FortiOS 5.6.3.

Improve FortiAnalyzer storage usage on Log Settings page (409658)

This feature improves FortiAnalyzer storage usage information in log settings to include more detailed per-ADOM
information as follows:

l (1) FAZ ADOM (Name)
Size / Used

l (2) Indexed Logs
Used / Available
Data Policy Days Configured / Actual

l (3) Compressed Logs
Used / Available
Data Policy Days Configured / Actual

Range change for maximum log age (440633)

The value range for "maximum-log-age" under "config log disk setting" has been limited to 0-3650.

New connect and disconnect event logs for FSSO server status change (446263)

Connect and disconnect event logs for FSSO server status changes have been added according to the following:

l When FSSO server status changes from disconnected to connected, record one connected event.
l When FSSO server status changes from connected to disconnected, record one disconnected event and send one

FSSO server disconnected alert email when set.

These logs must be enabled in the CLI.

Syntax

config alertemail setting
set FSSO-disconnect-logs

Security Fabric audit result logging to FortiGuard (452588)

The CLI now includes an option for the user to enable (by default) or disable FortiGuard security fabric audit result
submission.

If enabled, every time a user runs the Security Fabric audit test on the FortiGate, the audit result will be sent to
FortiGuard. When disabled, no audit data is sent to FortiGuard.

Security Audit categories have been reorganized and renamed to reflect the categories as they are in the security
audit matrix.

Syntax

config system global
set fortiguard-audit-result-submission [enable | disable]

end
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Config log disk uploadtime units change (400999)

Instructions for upload time under "config log disk setting" has been clarified by adding the phrase
'daily upload' and mentioning that this is the Hour. The help text also now includes the acceptable range for more
clarity.

Log field extension policy-name and meta-field (455441)

An option to include the policy name field has been added to traffic logs (log-policy-name). Likewise, an
option to add a meta-field tag to all logs has also been added (custom-field and custom-log-fields;
see below). This meta-field could be used for identifying the fortigate sending the logs, for example.

These options can only be enabled in the CLI.

Syntax

config log setting
set log-policy-name [enable | disable]

end
config log custom-field

edit "aaa"
set name "fielda"
set value "111"

next
end
config log setting

set custom-log-fields "aaa"
end

Rename logtime to eventtime (454445)

The "logtime" field in logs has been renamed to "eventtime" to avoid confusion. The logtime is the timestamp that
miglogd receives the message.

Logging and Reporting (5.6.1)
New logging and reporting features added to FortiOS 5.6.1.

Usability Updates to Reports Page (383684)

The Reports page has been updated in 5.6.1, to include both FortiCloud and Local Reports in a single location.
Configuring of report schedules is also available on this page. The page will display whichever format is enabled,
or allow switching between both if both Local and FortiCloud are in use.

Interface Categories (srcintfrole, etc) added to log data (434188)

In 5.6, logs and FortiView both sort log traffic into two interface categories: "Traffic from LAN/DMZ", and "Traffic
from WAN." For greater compatibility and troubleshooting of FortiAnalyzer and FortiCloud setups, interface
category fields that expose this information have been added to general log data in 5.6.1: srcintfrole and
dstintfrole for better backend control and monitoring.
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Logging and Reporting (5.6)
New logging and reporting features added to FortiOS 5.6.

All string values in log messages are enclosed in double quotes (399871)

In previous versions, some string log fields have double quotes and some do not. FortiOS 5.6 adds double-quotes
to all string fields in all log messages.

Some example log messages:

date=2017-01-27 time=10:46:26 logid="0001000014" type="traffic"
subtype="local" level="notice" vd="vd1" srcip=172.16.200.1 srcport=17856
srcintf=unknown-0 dstip=192.168.100.206 dstport=53 dstintf="port1"
sessionid=1461 proto=17 action="accept" policyid=0 dstcountry="Reserved"
srccountry="Reserved" trandisp="noop" service="DNS" app="DNS" duration=180
sentbyte=92 rcvdbyte=0 sentpkt=1 rcvdpkt=0 appcat="unscanned"

date=2017-01-27 time=10:36:34 logid="0107045071" type="event"
subtype="endpoint" level="notice" vd="vd1" logdesc="FortiClient Vulnerability
Scan" scantime=1467851105 fctuid="A8BA0B12DA694E47BA4ADF24F8358E2F"
user="test-user" srcip=192.168.25.26 srcname="test-pc"
srcmac="01:02:03:04:05:06" devtype="Windows PC" vulnid=25894
vulnname="Security Vulnerability CVE-2016-0636 in Oracle JDK"
vulncat="Applications" severity="critical" cveid="CVE-2016-0636"
vendorurl="http://www.oracle.com/technetwork/topics/security/alert-cve-2016-
0636-2949497.html" msg="Endpoint Vulnerbility Scan."

Client and server certificates included in Application control log messages (406203)

When SSL/TLS traffic triggers an application control signature, the application control log messages now include
information about the signatures used by the session. This includes the client certificate issuer, the name in the
server certificate, and the server certificate issuer.

DNS Logging (401757)

FortiOS logging now includes the Detailed DNS log message type. DNS events were previously recorded as event
logs. In FortiOS 5.6 DNS log messages are a new category that also includes more DNS log messages to provide
additional detail about DNS activity through the FortiGate. You can enable DNS logging from the CLI using the
following command (shown in this example for memory logging):

config log memory filter
set dns enable

end

DNS log messages include details of each DNS query and response. DNS log messages are recorded for all
DNS traffic though the FortiGate and originated by the FortiGate.

The detailed DNS logs can be used for low-impact security investigation. Most network activity involves DNS
activity of some kinds. Analyzing DNS logs can provide a lot of details about the activity on your network without
using flow or proxy-based resource intensive techniques.
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Added Policy Comment logging option (387865)

As an alternative to custom log fields, the functionality has been added to log a policy's comment field in all traffic
log files that use that policy, in order to sort/isolate logs effectively with larger deployments and VDOMs. The
feature is disabled by default.

config log setting
set log policy comment [enable/disable]

FortiAnalyzer encryption option name change (399191)

For clarity, and because the default options for config log fortianalyzer setting have now changed,
the option default has now been changed to high-medium in the following CLI commands:

config log fortianalyzer setting
set enc-algorithm [high/high-medium/low]

config log fortinalyzer override-setting
set enc-algorithm [high/high-medium/low]

config log fortiguard setting
set enc-algorithm [high/high-medium/low]

config log fortiguard override-setting
set enc-algorithm [high/high-medium/low]
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Maximum values changes
Maximum values changes in FortiOS 5.6.3:

l Merged FGT 90E/91E into trunk (386658).
l Merged FGT 3960E/3980E into 5.6 and trunk (435854).

Maximum values changes in FortiOS 5.6.1:

l The maximum number of SSIDs (CLI command config wireless-controller vap) for FortiGate models
600C, 600D, 800C, 800D, and 900D increased from 356 to 512 (414202).

l The maximum number DLP sensors (CLI command config dlp sensor / config filter) for models
1000C, 1000D, 1200D, 1500D, 1500DT, 3240C, and 3600C decreased from 10,000 to 3,000. (371270)

l The maximum number DLP sensors (CLI command config dlp sensor / config filter) for models
3000D, 3100D, 3200D, 3700D, 3700DX, 3800D, 3810D, 3815D, 5001C, and 5001D decreased from 50,000 to
4,000. (371270)

Maximum values changes in FortiOS 5.6:

l The maximum number of wireless controller QoS Profiles is per VDOM (388070).

Modem (5.6.1)
Newmodem features added to FortiOS 5.6.1.

New modem features (422266)

New FortiOS 5.6.1 modem features include:

l The ability to edit wireless profiles stored on EM7xmodems from FortiOS.
l GPS support.
l MIB for internal LTEmodems.
l Syslog messages for internal LTEmodems.
l More status information displayed by the diagnose sys lte-modem command
l Newmodem-related MIB entities.

config system let-modem command changes

The mode, interface, and holddown-timer options of the config system lte-modem command
have been removed. These options are no longer needed. Instead, use SD-WAN for redundant interfaces.

The config system lte-modem command includes the following options

status Enable/disable USB LTE/WIMAX device.

extra-init Extra initialization string to USB LTE/WIMAX device.

manual-handover Enable/Disable manual handover from 3G to LTE network. If enabled, the FortiGate
switches the modem firmware to LTEmode if the modem itself fails to do so after 5 loops.

force-wireless-profile Force the modem to use the configured wireless profile index (1 - 16), 0 if don't
force. If your FortiGate includes an LTE modem or if an LTEmodem is connected to it you can use the execute
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lte-modem command to list the LTEmodem profiles. Use this command to select one of these wireless
profiles.

Wireless profiles contain detailed LTEmodem data session settings. In each modem, a maximum of 16 wireless
profiles can be stored, any data connections are initiated using settings from one of the stored wireless profiles.
To make a data connection, at least one profile must be defined. Here is a sample wireless profile table stored in
one of the internal modems:

FG30EN3U15000025 # execute lte-modem wireless-profile list
ID Type Name APN PDP_Type Authen Username
*1 0 profile1 vzwims 3 0
2 0 profile2 vzwadmin 3 0
3 0 profile3 VZWINTERNET 3 0
4 0 profile4 vzwapp 3 0
5 0 profile5 vzw800 3 0
9 0 profile9 vzwims 2 0
10 0 profile10 vzwadmin 0 0
11 0 profile11 VZWINTERNET 0 0
12 0 profile12 vzwapp 3 0
13 0 profile13 0 0

Profile Type:
0 ==> QMI_WDS_PROFILE_TYPE_3GPP
1 ==> QMI_WDS_PROFILE_TYPE_3GPP2
* ==> Default 3GPP Profile, # ==> Default 3GPP2 Profile

Profile PDP Type:
0 ==> QMI_WDS_PDP_TYPE_IPV4
1 ==> QMI_WDS_PDP_TYPE_PPP
2 ==> QMI_WDS_PDP_TYPE_IPV6
3 ==> QMI_WDS_PDP_TYPE_IPV4_OR_IPV6

Authentication:
0 ==> QMI_WDS_AUTHENTICATION_NONE
1 ==> QMI_WDS_AUTHENTICATION_PAP
2 ==> QMI_WDS_AUTHENTICATION_CHAP
3 ==> QMI_WDS_AUTHENTICATION_PAP|QMI_WDS_AUTHENTICATION_CHAP

authtype Authentication type for PDP-IP packet data calls.

apn Log in APN string for PDP-IP packet data calls.

modem-port Modem port index (0 - 20).

network-type Set wireless network.

auto-connect Enable/disable Modem auto connect.

gpsd-enabled Enable/disable GPS daemon.

data-usage-tracking Enable/disable data usage tracking.

gps-port Modem port index (0 - 20). Specify the index for GPS port, by default it is set to 255 which means to
use the system default.
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execute lte-modem command changes

The following options are available for the execute lte-modem command:

cold-reboot Cold reboot LTEModem, which means power off the internal modem and power it on again after
1 second.

get-modem-firmware get-modem-firmware

get-pri-firmware get-pri-firmware

power-off Power off LTEModem.

power-on Power on LTEModem.

purge-billing-data Purge all existing LTEModem billing data.

reboot Warm reboot LTEModem.

set-operation-mode Set LTEModem operation mode to online or offline.

wireless-profile wireless-profile

cold-reboot, power-off, power-on, set-operation-mode, and wireless-profile are new in
FortiOS 5.6.1.

New execute lte-modem wireless-profile command

The following options are available for the execute lte-modem wireless-profile command:

create Create a wireless profile. You use the create command to create an LTEmodem profile by providing
a name and supplying settings for the profile. The command syntax is:

execute lte-modem wireless-profile create <name> <type> <pdp-type> <apn-name> <auth-type>
[<user> <password>]

<name>Wireless profile name of 1 to 16 characters.

<type>Wireless profile type:

l 0 for 3GPP profiles.
l 1 for 3GPP2 profiles.

<pdp-type>Wireless profile PDP type.

l 0 for IPv4
l 1 for PPP
l 2 for IPv6
l 3 for IPv4v6

<apn-name>Wireless profile APN name, 0 to 32 characters.

<auth-type>Wireless profile authentication type.

l 0 for no authentication.
l 1 for PAP
l 2 for CHAP
l 3 for PAP and CHAP
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[<user> <password>]Wireless profile user name and password (1 to 32 characters each). Not required if
<auth-type> is 0.

For example, use the following command to create an LTE modem 3GPP IPv4 profile named myprofile6. This
profile uses the APN profile named p6apn that uses PAP and CHAP authentication.

execute lte-modem wireless-profile create myprofile 0 0 myapn 3 myname mypasswd

delete <profile-number> Delete a wireless profile from the Modem. Speficy profile ID of the profile to
delete.

list List all the wireless profiles stored in the Modem. If the modem is busy the list may not display. If this
happens just repeat the command. It may take a few attempts.

modify Modify a wireless profile using the same settings as the create command except the first option is the
profile ID . You can find the profile ID for each profile by listing the profiles using the execute lte-modem
wireless-profile list command. For example, to modify the profile created above to change it to an
IPv4v6 profile, change the APN proflie to yourapn, and set the authentication type to PAP enter the following
command (assuming the profile ID is 6):

execute lte-modem wireless-profile modify 6 myprofile 0 3 yourapn 1 myname mypasswd

test Test wireless profiles.

Static mode for wwan interface removed (440865)

When configuring the wireless modem wwan interface from the CLI the mode can only be set to DHCP. Static
addressing for the wwan interface is not supported so the static option has been removed.
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Networking (5.6.3)
New networking features added to FortiOS 5.6.3.

Static Route GUI page updates (268344)

Updates have been made to the New Static Route/Edit Static Route page (underNetwork > Static Routes)
so as to avoid the device interface being selected first before the gateway. The admin can now specify the
gateway first, then the device interface will populate automatically based on the gateway. In addition, if the
gateway is not in the same subnet as the selected interface, a warning message will appear.

Advanced Routing GUI updates (413433, 445075)

Fixed an issue where an interface was not able to be deleted in the GUI underNetwork > Multicast > Multicast
Routing.

VXLAN interfaces can be attached to loopback interfaces (436773)

Support has been added for VXLAN unicast devices to be "binded" to the loopback interface as its underlying
interface:

l The IP address of the looback interface would be taken as the source IP for its outgoing VXLAN packets, so that the
peer knows where to reply.

l Among parameters passing to kernel, the ifindex of the loopback interface is not actually passed down to kernel, so
that the kernel can freely choose the physical outgoing interface.

VXLAN traffic can be routed across multiple physical links, providing resistance to single points of failure.

New option to configure DHCP renew time (440923)

Support has been added to allow you to set a mimimum DHCP renew time in seconds (under config system
interface). Note that this entry is only available when mode is set to dhcp.

Syntax

config system interface
edit {name}

set dhcp-renew-time <seconds>
next

end

Set the DHCP renew time range between 300-604800 (or five minutes to seven days). You can use the renew
time provided by the server by setting this entry to 0.

Show/add IPv6 address for CLI "get" under interface and CLI "fnsysctl/sysctl ifconfig
interface_id" (442988, 230480)

Client IPv6 DHCP addresses were only available to view in the CLI by using diagnose ipv6 address
list, but are also now available by entering get in the interface (under config system interface).

Similarly, static IPv6 addresses were available to view under diagnose ipv6 address list and by
entering get under the interface, but are also now available by entering fnsysctl/sysctl ifconfig
interface_id.
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DHCP Option 82 on Fortigate DHCP relay - RFC3046 (451456)

Support has been added to enable or disable DHCP relay option 82 (under config system interface), as
referenced in RFC3046: "Overall adding of the DHCP relay agent option SHOULD be configurable, and SHOULD
be disabled by default".

Syntax

config system interface
edit {name}

set dhcp-relay-agent-option {enable | disable}
next

end

Networking (5.6.1)
New networking features added to FortiOS 5.6.1.

IPv6 Router Advertisement options for DNS enhanced with recursive DNS server option
(399406)

This feature is based on RFC 6106 and it adds the ability to obtain DNS search list options from upstream
DHCPv6 servers and the ability to send them out through either Router Advertisement or FortiGate's DHCP
server.

FortiOS 5.6 supported the following:

To get the information from the upstream ISP server:

config system interface
edit wan1

config ipv6
set dhcp6-prefix-delegation enable

next
next

end

To use Routing Advertisement to send the DNS search list:

config system interface
edit port 1

config IPv6
set ip6-address 2001:10::/64
set ip6-mode static
set ip6-send-adv enable
config ip6-delegated-prefix-list
edit 1

set upstream-interface WAN
set subnet 0:0:0:11::/64
set autonomous-flag enable
set onlink-flag enable

next
next

end
end

To use DHCPv6 server to send DNS search list:

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

225

https://tools.ietf.org/html/rfc3046
https://tools.ietf.org/html/rfc6106


What's New in previous versions of FortiOS 5.6 Chapter 1 - What's New for FortiOS 5.6

config system dhcp6 server
edit 1

set interface port2
set upstream-interface WAN
set ip-mode delegated
set dns-service delegated
set dns-search-list delegated // this is a new command
set subnet 0:0:0:12::/64

next
end

In FortiOS 5.6.1 this feature has been enhanced to include the recursive DNS server option that sends the IPv6
recursive DNS server option to downstream clients with static prefix RA.

The new options include rdnss and dnssl in the following syntax:

config system interface
edit port1

config ipv6
config ip6-prefix-list

edit 2001:db8::/64
set autonomous-flag enable
set onlink-flag enable
set rdnss 2001:1470:8000::66 2001:1470:8000::72
set dnssl fortinet.com fortinet.ca

end

Temporarily mask interface failure (435426)

In some situations during normal operation, attached network equipment may cause a ForiGate interface to
appear to have disconnected from the network. And in some cases you may not want to the FortiGate interface to
detect and respond to the apparent interruption. For example, when Lawful Intercept (LI) devices are
inserted/removed from the network path using a switch mechanism the signal is entirely interrupted. That
interruption is seen by the FortiGate as an interface failure.

When the network path is interrupted, the FortiGate normally declares that the interface is down. All services
using the interface are notified and act accordingly.

This new feature allows the FortiGate interface to temporarily delay detecting that the interface is down. If the
connection is restored during the delay period, the FortiGate ignores the interface down condition and services
using the interface resume without apparent interruption.

Use the following command to enable and configure the down time for a FortiGate interface:

config system interface
edit port1

set disconnect-threshold <delay>
end

<delay> is the time to wait before sending a notification that this interface is down or disconnected (0 - 1000
ms, default = 0).

Policy Routes now appear on the routing monitor (411841)

You can go toMonitor > Routing Monitor and select Policy to view the active policy routes on your FortiGate.
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Control how the system behaves during a routing change (408971)

FortiOS allows you to dynamically make routing changes while the FortiGate unit is processing traffic. Routing
changes that affect the routing used for current sessions may affect how the FortiGate continues to process the
session after the routing change has been made.

Using the following command you can control whether FortiOS keeps (preserves) the routing for the sessions that
are using the route or causes the changed routing table to be applied to active sessions, possibly causing their
destinations to change.

config system interface
edit port2

set preserve-session-route {enable | disable}
end

If enabled, all sessions passing through port2 are allowed to finish without being affected by the routing changes.
If disabled (the default), when a route changes the new routing table is applied to the active sessions through
port2 which may cause their destinations to change.

Networking (5.6)
New networking features added to FortiOS 5.6.

New command to get transceiver signal strength (205138)

On most FortiGate models with SFP/SFP+ interfaces you can use the following command to display information
about the status of the transceivers installed in the SFP/SFP+ interfaces of the FortiGate.

The command output lists all of SFP/SFP+ interfaces and if they include a transceiver the output displays
information about it. The command output also includes details about transceiver operation that can be used to
diagnose transmission problems.

get system interface transceiver
...
Interface port14 - Transceiver is not detected.
Interface port15 - SFP/SFP+
Vendor Name : FIBERXON INC.
Part No. : FTM-8012C-SLG
Serial No. : 101680071708917

Interface port16 - SFP/SFP+
Vendor Name : FINISAR CORP.
Part No. : FCLF-8521-3
Serial No. : PS62ENQ

Optical Optical Optical
SFP/SFP+ Temperature Voltage Tx Bias Tx Power Rx Power
Interface (Celsius) (Volts) (mA) (dBm) (dBm)
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------------ ------------ ------------ ------------ ------------ ------------
port15 N/A N/A N/A N/A N/A
port16 N/A N/A N/A N/A N/A
++ : high alarm, + : high warning, - : low warning, -- : low alarm, ? : suspect.

New BGP local-AS support (307530)

Use the following command to configure BGP local-AS support:

config router bgp
config neighbor

edit "neighbor"
...
set local-as 300
set local-as-no-prepend disable|enable
set local-as-replace-as disable|enable

end

Enable local-as-no-prepend if you do not want to prepend local-as to incoming updates.

Enable local-as-replace-as to replace a real AS with local AS in outgoing updates.

Interface setting removed from SNMP community (310665)

The SNMPGUI has been cleaned up by removing the Interface setting.

RPF checks can be removed from the state evaluation process (311005)

You can remove stateful firewall RFP state checks without fully enabling asymmetric routing. State checks can be
disabled on specific interfaces. The following command shows how to disable state checks for traffic received by
the wan1 interface.

Disabling state checks makes a FortiGate unit less secure and should only be done
with caution.

config system interface
edit wan1

set src-check disable
end

BGP graceful-restart-end-on-timer, stale-route, and linkdown-failover options (374140)

If graceful-end-on-timer is enabled, the BGP graceful restart process will be stopped upon expiration of
the restart timer only.

If linkdown-failover is enabled for a BGP neighbor, the neighbor will be down when the outgoing interface
is down.

If stale-route is enabled for a BGP neighbor, the route learned from the neighbor will be kept for the
graceful-stalepath-time after the neighbor is down due to hold timer expiration or TCP connection
failure.

config router bgp
set graceful-end-on-timer disable|enable

config neighbor
edit 192.168.1.1

228 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New in previous versions of FortiOS 5.6

set linkdown-failover disable|enable
set stale-route disable|enable

graceful-end-on-timer stops BGP graceful restart process on timer only.

linkdown-failover and stale-route are options to bring down BGP neighbors upon link down and to
keep routes for a period after the neighbor is down.

FQDNs can be destination addresses in static routes (376200)

FQDN firewall addresses can now be used as destination addresses in a static route.

From the GUI, to add a FQDN firewall address (or any other supported type of firewall address) to a static route in
the firewall address configuration you must enable the Static Route Configuration option. Then when
configuring the static route set Destination to Named Address.

From the CLI, first configure the firewall FQDN address:

config firewall address
edit 'Fortinet-Documentation-Website'

set type fqdn
set fqdn docs.fortinet.com
set allow-routing enable

end

Then add the FQDN address to a static route.

config router static
edit 0

set dstaddr Fortinet-Documentation-Website
...

end

Priority for Blackhole routes (378232)

You can now add a priority to a blackhole route to change its position relative to kernel routes in the routing table.
Use the following command to add a blackhole route with a priority:

config router static
edit 23

set blackhole enable
set priority 200

end

New DDNS refresh interval (383994)

A new DDNS option has been added to configure the FortiGate to refresh DDNS IP addresses by periodically
checking the configured DDNS server.

config system ddns
edit 1

set ddns-server FortiGuardDDNS
set use-public-ip enable
set update-interval seconds

end

The default update-interval is 300 seconds and the range is 60 to 2592000 seconds.
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Support IPv6 blackhole routes on GUI (388599)

IPv6 blackhole routes are now supported from GUI, go to Network > Static Routes and select Create New >
IPv6 Route.

Choose Blackhole forDevice field.

SSL-VPN can use a WAN link load balancing interface (396236)

Virtual-wan-link interface can now be set as a destination interface in SSLVPN policy.

Also SSL-VPN interface can now be set as a source interface for WAN LLB.

DDNS support for noip.com (399126)

Noip.com, and provider for Dynamic DNS has been added as a supported option for a ddns-server.

CLI

config system ddns
edit <ddns_ip>

set ddns-server
[dyndns.org|dyns.net|ods.org|tzo.com|vavic.com|dipdns.net|now.net.cn||dhs.org|ea
sydns.com|genericDDNS|FortiGuardDDNS|noip.com]

IPv6 Router Advertisement options for DNS (399406)

This feature is based on RFC 6106 and it adds the ability to obtain DNS search list options from upstream
DHCPv6 servers and the ability to send them out through either Router Advertisement or FortiGate's DHCP
server.

Configuration example:

To get the information from the upstream ISP server:

config system interface
edit wan1

config ipv6
set dhcp6-prefix-delegation enable

next
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next
end

To use Routing Advertisement to send the DNS search list:

config system interface
edit port 1

config IPv6
set ip6-address 2001:10::/64
set ip6-mode static
set ip6-send-adv enable
config ip6-delegated-prefix-list
edit 1

set upstream-interface WAN
set subnet 0:0:0:11::/64
set autonomous-flag enable
set onlink-flag enable

next
next

end
end

To use DHCPv6 server to send DNS search list:

config system dhcp6 server
edit 1

set interface port2
set upstream-interface WAN
set ip-mode delegated
set dns-service delegated
set dns-search-list delegated // this is a new command
set subnet 0:0:0:12::/64

next
end

WAN LLB to SD-WAN on GUI (403102)

To be more consistent with current terminology, the termWAN LLB has been changed in the GUI to the more
recognizable SD-WAN.
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New RFCs
The following RFCs are now supported by FortiOS 5.6.3 or the support for these RFCs has been enhanced in
FortiOS 5.6.3:

l RFC 7627 Transport Layer Security (TLS) Session Hash and Extended Master Secret Extension (443870)

The following RFCs are now supported by FortiOS 5.6.1 or the support for these RFCs has been enhanced in
FortiOS 5.6.1:

l RFC 6954 Using the Elliptic Curve Cryptography (ECC) Brainpool Curves for the Internet Key Exchange Protocol
Version 2 (IKEv2) (412795)

l RFC 6106 IPv6 Router Advertisement Options for DNSConfiguration (399406)
l RFC 4787 Network Address Translation (NAT) Behavioral Requirements for Unicast UDP (408875)
l Improved enforced secure-renegotiation checks support for RFC 5746 Transport Layer Security (TLS)

Renegotiation Indication Extension (422133)
l RFC 7627 Transport Layer Security (TLS) Session Hash and Extended Master Secret Extension (422133)

The following RFCs are now supported by FortiOS 5.6 or the support for these RFCs has been enhanced in
FortiOS 5.6:

l RFC 7427 Signature Authentication in the Internet Key Exchange Version 2 (IKEv2) (389001)
l RFC 7348 Virtual eXtensible Local Area Network (VXLAN) or VTEP (289354)
l RFC 5996 (section 2.15) IKEv2 asymmetric authentication (393073)
l RFC 6106 IPv6 Router Advertisement Options for DNS (399406)
l RFC 7383 Internet Key Exchange Protocol Version 2 (IKEv2) Message Fragmentation (371241)
l RFC 3971 IPv6 Secure Neighbor Discovery (SEND) (355946)
l RFC 6023 Childless IKEv2 Initiation (381650)

Sandbox Integration (5.6.1)
New sandbox integration features added to FortiOS 5.6.1.

New file extension lists for determining which file types to send to FortiSandbox (379326)

This feature introduces two new file extension lists:

l File extensions to submit to FortiSandbox even though the AV engine says they are unsupported.
l File extensions to exclude from submitting to FortiSandbox even though the AV engine says they are supported.

These lists are configured on the FortiSandbox, not the FortiGate, and are dynamically loaded on the FortiGate
via quarantine.

These lists are only file extensions and not file types detected by the AV engine using
magic bytes. Pattern matching is done on the extension of the filename only.

Syntax

diag sys scanunit reload-fsa-ext
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FortiSandbox integration with AntiVirus in quick mode (436380)

FortiSandbox options in an AntiVirus Security Profile in quick scanning mode can now be enabled with CLI
commands.

CLI syntax

config antivirus profile
edit default

set ftgd-analytics disable/everything
set analytics-max-upload 10
set analytics-wl-filetype 0
set analytics-bl-filetype 0
set analytics-db enable/disable
set scan-mode quick

end

Security Fabric (5.6.3)
New Security Fabric features added to FortiOS 5.6.3.
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Security Profiles (5.6.3)
New security profile features added to FortiOS 5.6.3.

Added multiple ports and port range support in the explicit ftp/web proxy (402775)

Added multiple ports and port range support in the explicit ftp/web proxy:

l added new monitor api endpoint for checking whether a list of TCP port ranges is being used, sample usage:
/api/v2/monitor/system/check-port-availability?port_ranges=[{"start":8080,"end":8080},{"start":400,"end":600},
{"start":1,"end":200}]&service=webproxy

l added GUI support for port ranges in web-proxy and ftp-proxy settings

Block access to unsupported FortiClient endpoints (457695)

You can use the following command to deny registration of unsupported FortiClients endpoints. An unsupported
FortiClient endpoint means the endpoint is running FortiClient but for some reason not all of the criteria are
available to identify the endpoint, or the endpoint may be running an unsupported version of FortiClient.
Information required that is not available could include the endpoint's IP address or MAC address is not visible.

config endpoint-control setting
set forticlient-dereg-unsupported-client {enable | disable}

end

Exempt list fix (381762)

The FortiClient Monitor page now shows exempt device types, as opposed to just the device category. FortiOS
can now differentiate the three cases both from backend and GUI.

Backend changes

Differentiate the three cases:

l exempt by custom device
l exempt by device category
l exempt by device group

GUI changes

1. Monitor > FortiClient Monitor page:
l show device exempt reasons as any combination of device, device category, device group, source address.

2. Update REST monitor api
l (URI: /api/v2/monitor/user/device/select?compliance_visibility=true)
l update "exempt_reason" field from string to array of strings in json result

Security Profiles (5.6.1)
New security profile features added to FortiOS 5.6.1.
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FortiGuard WAN IP blacklist service is now online (404859)

The Fortiguard WAN IP blacklist service was not online in FortiOS 5.6.0. In FortiOS 5.6.1, a notification appears
on theDashboardwhen WAN IP is blacklisted. Clicking on the notification brings up the blacklist details.

Application Control GUI improvements (279956)

An All Categories button on the Security Profiles > Application Control page makes it easier to apply an
action (Monitor, Allow, Block, Quarantine) to all categories at once.

Note that the All Categories selector goes blank when any of theactions to be applied to individual categories is
manually changed to something different than what was selected for all the categories. The Unknown
Application action will match the All Categories action unless that action is Quarantine, which is unsupported
for unknown applications.

Industrial Application Control signatures (434592)

The application control category Industrial is now controlled by a FortiGuard license and the default disable mask
is no longer needed. The special category is also no longer used.

GUI updates to reflect package and license changes for IPS, Application Control and
Industrial signatures (397010)

The following changes have been made to the GUI to reflect changes in the signature databases:

l Application Control signature database information is displayed under on the System > FortiGuard page in the
FortiCare section.

l The IPS package version and license status are shown in a separate section in System > FortiGuard page. A link
to manually upload the IPS database signatures has been added.

l The Industrial package version and license status are shown in a separate section in System > FortiGuard page.
A link to manually upload the Industrial database signatures is available. Access to the Industrial database is
provided with the purchase of the FortiGuard Industrial Security Service. The row item for this license will not
appear if you are not subscribed.

l Botnet category is no longer available when searching the Application Signatures list.

Improved FortiClient monitor display (378288)

The GUI for theMonitor > FortiClient Monitor page has been revised.

l new dropdown option: Online Only or Include Offline. The default isOnline Only.
l new dropdown option

l Sending FortiTelemetry Only (default)
l Include All FortiTelemetry States
l Not Sending FortiTelemetry Only

l update: Compliance status for offline device isN/A
l update: offline status indicator to grey
l new compliance status text after the icon in Compliance column
l Moved Compliance column after Status column
l Combined unregistered endpoint devices with not registered devices
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FortiSandbox integration with AntiVirus in quick mode (436380)

FortiSandbox options in an AntiVirus Security Profile in quick scanning mode can now be enabled with CLI
commands.

CLI syntax

config antivirus profile
edit default

set ftgd-analytics disable/everything
set analytics-max-upload 10
set analytics-wl-filetype 0
set analytics-bl-filetype 0
set analytics-db enable/disable
set scan-mode quick

end

Pre-configured parental controls for web filtering (399715)

Pre-configured filters based on the Motion Picture Association of America (MPAA) ratings can now be added to
the Web Filter Security Profile. This feature is already available on FortiCloud and uses the same ratings
categories.

Anti-Spam GUI updates (300423)

Changes made to the Anti-Spam profile update the GUI to reflect FortiOS 5.6 style.

Security Profiles (5.6)
New security profile features added to FortiOS 5.6.

New FortiGuard Web Filter categories (407574)

New categories added to FortiGuard Web Filter sub-categories:

l Under Security Risk:
l Newly Observed Domain (5.90)
l Newly Registered Domain (5.91)

l Under General Interest - Business
l Charitable Organizations (7.92)
l Remote Access (7.93)
l Web Analytics (7.94)
l Online Meeting (7.95)

Newly observed domain (NOD) applies to URLs whose domain name is not rated and were observed for the first
time in the past 30 minutes.

Newly registered domain (NRD) applies to URLs whose domain name was registered in the previous 10 days.

Overall improvement to SSL inspection performance (405224)

The enabling / disabling of proxy cipher / kxp hardware acceleration in CP8/CP9 required restarting of the WAD
daemon for the change to take effect; this bug has been repaired.
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New CLI commands

The FortiGate will use the ssl-queue-threshold command to determine the maximum queue size of the
CP SSL queue. In other words, if the SSL encryption/decryption task queue size is larger than the threshold, the
FortiGate will switch to use CPU rather than CP. If less, it will employ CP.

config firewall ssl setting
set ssl-queue-threshold <integer>

end

The integer represents the maximum length of the CP SSL queue. Once the queue is full, the proxy switches
cipher functions to the main CPU. The range is 0 - 512 and the default is 32.

FortiClient Endpoint license updates (401721)

FortiClient endpoint licenses for FortiOS 5.6.0 can be purchased in multiples of 100. There is a maximum client
limit based on the FortiGate's model. FortiCare enforces the maximum limits when the customer is applying the
license to a model.

If you are using the ten free licenses for FortiClient, support is provided on the Fortinet Forum
(forum.fortinet.com). Phone support is only available for paid licenses.

Model(s) Maximum client limit

VM00 200

FGT/FWF 30 to 90 series 200

FGT 100 to 400 series 600

FGT 500 to 900 series, VM01, VM02 2,000

FGT 1000 to 2900 series 20,000

FGT 3000 to 3600 series, VM04 50,000

FGT 3700D and above, VM08 and above 100,000

Older FortiClient SKUs will still be valid and can be applied to FortiOS 5.4 and 5.6.

If you are using the ten free licenses for FortiClient, support is provided on the Fortinet
Forum (forum.fortinet.com). Phone support is only available for paid licenses.

FortiClient Vulnerability Exemption Setting (407230)

A new CLI command provides a manual override for client computers with vulnerabilities that cannot be fixed.

CLI Syntax

New command to enable/disable compliance exemption for vulnerabilities that cannot be auto patched. Default
is disable.
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config endpoint-control profile
edit <profile-name>

config forticlient-winmac-setting
set forticlient-vuln-scan enable
set forticlient-vuln-scan-exempt [enable|disable]

end
next

end

DNS profile supports safe search (403275)

Users can take advantage of pre-defined DNS doctor rules to edit DNS profiles and provide safe search for
Google, Bing, and YouTube.

To add safe search to a DNS profile - GUI

1. Go to Security Profiles > DNS Filter.
2. Edit the default filter or create a new one.
3. Enable Enforce 'Safe Search on Google, Bing, YouTube.
4. Select Strict orModerate level of restriction for YouTube Access.

To add safe search to a DNS profile - CLI

config dnsfilter profile
edit "default"

set safe-search enable
set youtube-restrict {strict | moderate} (only available is safe-search enabled)

next
end

Application control and Industrial signatures separate from IPS signatures (382053)

IPS, Application control and industrial signatures have been separated. The get system status command shows
the versions of each signature database:

get system status
Version: FortiGate-5001D v5.6.0,build1413,170121 (interim)
Virus-DB: 42.00330(2017-01-23 01:16)
Extended DB: 1.00000(2012-10-17 15:46)
Extreme DB: 1.00000(2012-10-17 15:47)
IPS-DB: 6.00741(2015-12-01 02:30)
IPS-ETDB: 0.00000(2001-01-01 00:00)
APP-DB: 6.00741(2015-12-01 02:30)

Changes to default SSL inspection configuration (380736)

SSL inspection is mandatory in the CLI and GUI and is enabled by default.

GUI Changes

l Updated edit dialogues for IPv4/IPv6 Policy and Explicit Proxy Policy
l SSL/SSH inspection data displayed in muted palette
l disabled the toggle button for this option
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l set the default profile as "certificate-inspection"
l Updated list pages for IPv4/IPv6 Policy and Explicit Proxy Policy

l Add validation for "ssl-ssh-profile" when configuring UTM profiles
l Updated SSL/SSH Inspection list page

l disabled delete menu on GUI for default ssl profiles
l changed "Edit" menu to "View" menu for default ssl profiles
l added implicit class (grayed) the default ssl profile entries

l Updated SSL/SSH Inspection edit dialog
l disabled all the inputs for default ssl profiles except download/view trusted certificate links
l changed button to "Return" for default ssl profiles to return the list page

l Updated Profile Group edit dialog
l removed checkbox for "ssl-ssh-profile" option, make it always required.

CLI changes

1. ssl-ssh-profile default value is certificate-inspection when applicable in table
firewall.profile-group, firewall.policy, firewall.policy6, firewall.explicit-proxy-policy

2. make default profiles "certificate-inspection", "deep-ssl-inspection' read only in table firewall.ssl-ssh-profile

Block Google QUIC protocol in default Application Control configuration (385190)

QUIC is an experimental protocol from Google. With recent Google Chrome versions (52 and above), and
updated Google services, more than half of connections to Google servers are now in QUIC. This affects the
accuracy of Application Control. The default configuration for Application control blocks QUIC.

Users may enable QUIC with CLI commands.

CLI Syntax

config application list
edit <profile-name>

set options allow-quic
end

Botnet database changes (390756)

Starting in FortiOS 5.6, FortiGate units and FortiGuard Distribution Servers (FDS0 will use object IDs IBDB and
DBDB to download and update the Botnet database. Botnet protection will be part of the AntiVirus contract.

FortiOS 5.4 uses object IDs IRDB and BDDB.

Fortinet Security Fabric audit check for endpoint vulnerability and unauthorized FAP and FSW
(401462)

The new Security Fabric Audit feature allows for the display of endpoint vulnerability status in real-time. Users
can see:

l FortiClient devices that have critical vulnerabilities detected.
l Discovered FortiSwitches that have not yet been authorized.
l Discovered FortiAPs that have not yet been authorized.
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Change to CLI commands for configuring custom Internet services (397029)

Custom internet services are no longer configured through use of the commands config application
internet-service and config application internet-service-custom in the CLI.

These commands are replaced by config firewall internet-service and config firewall
internet-service-custom.

CLI Syntax - examples

config firewall internet-service 1245324
set name "Fortinet-FortiGuard"
set reputation 5
set icon-id 140
set offset 1602565

config entry
edit 1

set protocol 6
set port 443
set ip-range-number 27
set ip-number 80

next
edit 2

set protocol 6
set port 8890
set ip-range-number 27
set ip-number 80

next
edit 3

set protocol 17
set port 53
set ip-range-number 18
set ip-number 31

next
edit 4

set protocol 17
set port 8888
set ip-range-number 18
set ip-number 31

next
end

end

config firewall internet-service-custom
edit "custom1"

set comment "custom1"
config entry

edit 1
set protocol 6
config port-range

edit 1
set start-port 30
set end-port 33

next
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end
set dst "google-drive" "icloud"

next
end

next
end

Enable "sync-session-ttl" in "config ips global" CLI by default (399737)

sync-session-ttl is now set to enable by default in order to:

l enhance detection of P2P traffic. Efficient detection of P2P is important on hardware accelerated platforms
l ensure that IPS and the kernel use the same ttl
l ensure that IPS sessions time out sooner

CASI functionality moved into application control (385183, 372103)

Cloud Access Security Inspection (CASI) is merged with Application Control resulting in changes to the GUI and
the CLI.

GUI Changes

l Toggle option added to quickly filter CASI signatures in the Application Signatures list.
l Application Overrides table now shows any parent-child hierarchy using the --parent metadata on signatures.

Deleting a parent app also deletes its child apps. And conversely, adding a child app will add all its parent apps but
with implicit filter action.

l A policy breakdown is shown on existing application control profiles for policies using the profile. The breakdown
indicates which policies are using a deep inspection.

l A breakdown is shown for application categories and filter overrides to indicate the number of CASI and non-CASI
signatures. A lock icon is shown for applications requiring deep inspection.

CLI Changes

Commands removed:

l config application casi profile

l casi profile in config firewall policy

l casi profile in config firewall policy6

l casi-profile-status and casi-profile under config firewall sniffer

l casi-profile-status and casi-profile under config firewall interface-policy

New diagnose command to delete avatars (388634)

Commands to delete avatars by FortiClient UID or avatar name have been added to the CLI.

the two following commands has been added to diagnose endpoint avatar:

l diagnose endpoint avatar delete <ftcl_uid>

l diagnose endpoint avatar delete <ftcl_uid> <username>
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The attribute delete did not exist before. The values <fctl_uid> and <user_name> describe a set of
avatars. If only <fctl_uid> is defined, all avatars belonging to this FortiClient UID that are not being used will
be removed. If both values are defined, the avatar belonging to them will be removed unless they are being used
in which case this call will cause an error to user.

Fortinet bar option disabled in profile protocol options when VDOM is in flow-based
inspection mode (384953)

In order to prevent the Fortinet Bar from being enabled and redirecting traffic to proxy (WAD) when a VDOM is in
flow-based mode, the Fortinet Bar option is disabled in profile protocol options.

SSL/SSH profile certificate handling changes (373835)

In order to support DSA and ECDSA key exchange (in addition to RSA) in SSL resign and replace mode, CLI
commands for deep-inspection have changed. The certname command in ssl-ssh-profile has
been removed.

To select from the list of available certificates in the system, use the CLI below.

edit deep-inspection
set server-cert-mode re-sign
set certname-{rsa | dsa | ecdsa}

Restricting access to YouTube (replacement for the YouTube Education filter feature)
(378277)

Previous versions of FortiOS supported YouTube for Schools (YTfS). As of July 1, 2016 this feature is no longer
supported by YouTube. Instead you can use the information in the YouTube support article Restrict YouTube
content on your network or managed devices to achieve the same result. FortiOS supports applying Strict or
Moderate restrictions using HTTP headers as described in this article.

In FortiOS 5.6 with inspection mode set to proxy-based, in a Web Filter profile under Search Engines you can
select Restrict YouTube Access and select either Strict orModerate.

Enhancements to IPS Signatures page (285543)

The IPS signatures list page now shows which IPS package is currently deployed. Users can also change their IPS
package by linking directly to the FortiGate'sSystem > FortiGuard page from the IPS Signatures list page.

DLP sensor GUI changes (307225)

The DLP sensor for file size has been corrected to indicate that the file size has to be greater than the number of
KB entered. Previously, the GUI incorrectly showed that the files size could be greater than or equal to the
number of KB entered.
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Web Filter profile page GUI updates (309012)

The GUI for theWeb Filter security profile andWeb Profile Overrides pages are changed.

Web Filter profile page

l removed multilist for override user group and profile
l replaced FortiGuard categories actions icons with font icons
l added tooltip forAllow users to override blocked categories to explain the policy group dependency

Web Profile Overrides page

l removed multilist of user, user group, original profile, new profile
l duplicate profile for new profile (for bug #284239)

Web Filter Quota traffic can no longer be set to 0 (374380)

To fix a bug in older major release, the CLI has been changed so that minimum traffic quota does not allow 0 as
an entry. The value entered must be in the range of 1 - 4,294,967,295; if 0 is entered, then an error message will
be returned.

CLI Commands:

config webfilter profile
edit default

config ftgd-wf
config quota

edit 1
set type traffic
set value {a number in the range of 1 - 4,294,967,295}

Webcache-https and SSL deep inspection profile configuration changes (381101)

In older releases, the CLI blocked the configuration of the SSL deep inspection profile when webcache-https was
enabled. This bug is fixed in FortiOS 5.6.0.

FortiGate conserve mode changes (242562, 386503)

The following changes were made to rework conserve mode and facilitate its implementation:

l Implemented CLI commands to configure extreme, red, and greenmemory usage thresholds in percentages of
total RAM. Memory used is the criteria for these thresholds, and set at 95% (extreme), 88% (red) and 82% (green).

l Removed structure av_conserve_mode, other changes in kernel to obtain and set memory usage thresholds from
the kernel

l Added conserve mode diagnostic command diag hardware sysinfo conserve, which displays information
about memory conserve mode.

l Fixed conserve mode logs in the kernel
l Added conserve mode stats to the proxy daemon through command diag sys proxy stats all | grep
conserve_mode
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New custom IPS and Application Control Signatures list (280954)

You can now create IPS and Application control custom signatures by going to Security Profiles > Custom
Signatures. From here you can create and edit all custom IPS and Application Control signatures.

Default inspection mode set to flow-based (377392)

In FortiOS 5.6.0, the following changes were made to inspection mode:

l factory default sets the FortiGate to flow-based inspection with VDOM disabled
l whenever a VDOM is created, the default inspection mode is flow-based

You must use the CLI to set the FortiGate to proxy-based inspection. To change the inspection mode back to
flow-based inspection, you may use the GUI or the CLI.

config system settings
edit <name_str>
set inspection-mode {proxy | flow}

end
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Server Load balancing (5.6.1)
New load balancing features added to FortiOS 5.6.1.

Add server load balancing real servers on the Virtual Server GUI page (416709)

In previous versions of the FortiOSGUI, after adding a Virtual Server you would go to Policy & Objects > Real
Servers to add real servers and associate each real server with a virtual server.

In FortiOS 5.6.1 you now go to Policy & Objects > Virtual Servers, configure a virtual server and then from
the same GUI page add real servers to the virtual server. In addition, on the Virtual Server GUI page the option
Outgoing Interface is renamed Interface and the load balancing method Source IP Hash has been renamed
Static.
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Server Load balancing (5.6)
New load balancing features added to FortiOS 5.6.

IPv6, 6to4, and 4to6 server load balancing (280073)

Sever load balancing is supported for:
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l IPv6 VIPs (config firewall vip6)
l IPv6 to IPv4 (6to4) VIPs (config firewall vip64)
l IPv4 to IPv6 (4to6) VIPs (config firewall vip46)

Configuration is the same as IPv4 VIPs, except support for advanced HTTP and SSL related features is not
available. IPv6 server load balancing supports all the same server types as IPv4 server load balancing (HTTP,
HTTPS, IMAPS, POP3S, SMTPS, SSL, TCP, UDP, and IP). IPv4 to IPv6 and IPv6 to IPv4 server load balancing
supports fewer server types (HTTP, TCP, UDP, and IP).

Improved Server load balancing GUI pages (404169)

Server load balancing GUI pages have been updated and now include more functionality and input verification.
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Session-aware Load Balancing (SLBC) (5.6.1)
New SLBC features added to FortiOS 5.6.1.

FortiController-5000 series independent port splitting (42333)

FortiOS 5.6.1 supports splitting some 40G FortiController front panel fiber channel front panel interfaces in to
10G ports. In previous versions of FortiOS this configuration was not supported and all FortiController fiber
channel front panel interfaces had to operate at the same speed.
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SSL VPN (5.6.3)
New SSL VPN features added to FortiOS 5.6.3.

Virtual desktop option no longer supported (442044)

The SSL VPN web portal no longer supports the virtual desktop and its option has been removed from the
interface.

Option to disable FortiClient download in web portal (439736)

You can use the following commands to enable or disable allowing SSL VPN users to download FortiClient from
the SSL VPN web portal. If forticlient-download is enabled, you can select the download method
(direct or over the ssl_vpn). You can also optionally specify a custom URL for downloading the Windows and
Mac OS versions of FortiClient.

Syntax

config vpn ssl web portal
edit <portal name>

set forticlient-download {enable | disable}
set forticlient-download-method {direct | ssl-vpn}
set customize-forticlient-download-url {enable | disable}
set windows-forticlient-download-url <url>
set macos-forticlient-download-url <url>

end

Upgraded OpenSSL to 1.1.x (412033) (...)

OpenSSL has been upgraded to 1.1 to provide more cryptographic algorithms. All 3rd-party libraries that depend
on OpenSSL have also been updated. OpenLDAP has been upgraded to 2.4.45 to be compatible with OpenSSL
1.1. Furthermore, the sslv3 attribute has been removed from vpn.ssl.settings and global.admin-
https-ssl-version.

SSL VPN (5.6.1)
New SSL VPN features added to FortiOS 5.6.1.

Added a button to send Ctrl-Alt-Delete to the remote host for VNC and RDP desktop
connections (401807)

Previously, users were unable to send Ctrl-Alt-Delete to the host machine in an SSL VPN remote desktop
connection.

FortiOS 5.6.1 adds a new button that allows users to send Ctrl-Alt-Delete in remote desktop tools (also fixes
412456, preserving the SSL VPN realm after session timeout prompts a logout).

Improved SSL VPN Realms page (0392184)

Implemented minor functional changes to the dialog on the SSL VPN > Realms page:

l URL preview uses info message similar to that seen on the SSL VPN settings dialog.
l Virtual-Host input is now visible when set in the CLI.
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l Added help tooltip describing what the virtual-host property does.

Customizable FortiClient Download URL in SSL VPN Web Portal (437883)

A new attribute, customize-forticlient-download-url, is added to vpn.ssl.web.portal.

The added attribute indicates whether to support a customizable download URI for FortiClient. This attribute is
disabled by default. If enabled, two other attributes, windows-forticlient-download-url and macos-
forticlient-download-url, will appear through which the user can customize the download URL for
FortiClient.

Syntax

config vpn ssl web portal
edit <portal>

set customize-forticlient-download-url {enable | disable}
set windows-forticlient-download-url <custom URL for Windows>
set macos-forticlient-download-url <custom URL for Mac OS>

next
end

SSL VPN SSO Support for HTML5 RDP (417248)

This feature adds support for SSO from the SSL VPN portal to an RDP bookmark. If SSO is used, then the
credentials used to login to SSL VPN will be automatically used when connecting to a remote RDP server.

Syntax

conf vpn ssl web user-bookmark
edit <name>

config bookmarks
edit <name>

set apptype rdp
set host "x.x.x.x"
set port <value>
set sso [disable | auto]

next
end

next
end

SSL VPN (5.6)
New SSL VPN features added to FortiOS 5.6.

Remote desktop configuration changes (410648)

If NLA security is chosen when creating an RDP bookmark, a username and password must be provided.
However there may be instances where the user might want to use a blank password, despite being highly
unrecommended. If a username is provided but the password is empty, the CLI will display a warning. See
example CLI below, where the warning appears as a caution before finishing the command:

config vpn ssl web user-group-bookmark
edit <group-name>

config bookmarks
edit <bookmark-name>
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set apptype rdp
set host 172.16.200.121
set security nla
set port 3389
set logon-user <username>

next
end

Warning: password is empty. It might fail user authentication and remote desktop
connection would be failed.

end

If no username (logon-user) is specified, the following warning message will appear:

Please enter user name for RDP security method NLA. object set operator error, -2010
discard the setting Command fail. Return code -2010

SSL VPN supports WAN link load balancing interface (396236)

This new feature allows you to set virtual-wan-link as the destination interface in a firewall policy (when
SSL VPN is the source interface) for WAN link load balancing in the GUI and in the CLI. This lets you log into a
FortiGate via SSL VPN for traffic inspection and then have outbound traffic load balanced byWAN link load
balancing.

Syntax

config firewall policy
edit <example>

set dstintf virtual-wan-link
end

SSL VPN login timeout to support high latency (394583)

With long network latency, the FortiGate can timeout the client before it can finish negotiation processes, such as
DNS lookup and time to enter a token. Two new CLI commands under config vpn ssl settings have
been added that allow the login timeout to be configured, replacing the previous hard timeout value. The second
command can be used to set the SSL VPN maximum DTLS hello timeout.

Syntax

config vpn ssl settings
edit <example>

set login-timeout [10-180] Default is 30 seconds.
set dtls-hello-timeout [10-60] Default is 10 seconds.

end

SSL VPN supports Windows 10 OS check (387276)

A new CLI field has been added to the os-check-list under config vpn ssl web portal to allow OS
checking for Windows 10.

Syntax

config vpn ssl web portal
edit <example>
set os-check enable
config os-check-list windows-10

set action {deny | allow | check-up-to-date}

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

251



What's New in previous versions of FortiOS 5.6 Chapter 1 - What's New for FortiOS 5.6

end
end

SSL VPN DNS suffix per portal and number of portals (383754)

A new CLI command under config vpn ssl web portal to implement a DNS suffix per SSL VPN portal.
Each suffix setting for each specific portal will override the dns-suffix setting under config vpn ssl
settings.

This feature also raises bookmark limits and the number of portals that can be supported, depending on what
FortiGate series model is used:

l 650 portals on 1000D series
l 1300 portals on 2000E series
l 2600 portals on 3000D series

The previous limit for 1000D series models, for example, was 256 portals.

Syntax

config vpn ssl web portal
edit <example>

set dns-suffix <string>
end

New SSL VPN timeout settings (379870)

New SSL VPN timeout settings have been introduced to counter 'Slowloris' and 'R-U-Dead-Yet' vulnerabilities that
allow remote attackers to cause a denial of service via partial HTTP requests.

The FortiGate solution is to add two attributes (http-request-header-timeout and http-request-
body-timeout).

Syntax

config vpn ssl settings
set http-request-header-timeout [1-60] (seconds)
set http-request-body-timeout [1-60] (seconds)

end

Personal bookmark improvements (377500)

You can now move and clone personal bookmarks in the GUI and CLI.

Syntax

config vpn ssl web user-bookmark
edit 'name'

config bookmarks
move bookmark1 after/before
clone bookmark1 to

next
end
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New controls for SSL VPN client login limits (376983)

Removed the limitation of SSL VPN user login failure time, by linking SSL VPN user setting with config user
settings and provided a new option to remove SSL VPN login attempts limitation. New CLI allows the
administrator to configure the number of times wrong credentials are allowed before SSL VPN server blocks an IP
address, and also how long the block would last.

Syntax

config vpn ssl settings
set login-attempt-limit [0-10] Default is 2.
set login-block-time [0-86400] Default is 60 seconds.

end

Unrated category removed from ssl-exempt (356428)

The "Unrated" category has been removed from the SSL Exempt/Web Category list.

Clipboard support for SSL VPN remote desktop connections (307465)

A remote desktop clipboard viewer pane has been added which allows user to copy, interact with and overwrite
remote desktop clipboard contents.
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System (5.6.3)
New system administration features added to FortiOS 5.6.3.

System (5.6.1)
New system administration features added to FortiOS 5.6.1.

Use self-sign as default GUI certificate if BIOS cert is using SHA-1 (403152)

For increased security, SHA-1 certificate has been replaced by self-sign certificate as the default GUI certificate,
if the BIOS certificate is using SHA-1.

Administrator timeout override per access profile (413543)

The GUI is often used for central monitoring. To do this requires the inactivity timeout to be increased, to avoid
an admin having to constantly log in over again. This new feature allows the admintimeout value, under
config system accprofile, to be overridden per access profile.

Note that this can be achieved on a per-profile basis, to avoid the option from being unintentionally set globally.

CLI Syntax - Configure admin timeout

config system accprofile
edit <name>

set admintimeout-override {enable | disable}
set admintimeout <0-480> - (default = 10, 0 = unlimited)

next
end

New execute script command (423159)

A new execute command has been introduced to merge arbitrary configlets into the running configuration from
script. The command's authentication can be carried out using either username and password or with a
certificate. This command supports FTP/TFTP and SCP.

An important benefit of this feature is that if the configuration in the script fails (i.e. a syntax error), the system will
revert back to running configurations without interrupting the network.

CLI Syntax - Load script from FTP/TFTP/SCP server to firewall

execute restore scripts <ftp | tftp |
scp> <dir / filename in server> <server ip> <username> <password>

System (5.6)
New system administration features added to FortiOS 5.6.
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Remove CLI commands from 1-CPU platforms (405321)

Two CLI commands that set CPU affinity have been removed from 1-CPU platforms since they do not have any
impact on these platforms. The commands are config system global > set miglog-affinity and
config system global > set av-affinity <string>.

New SNMP trap for bypass events (307329)

When bypass mode is enabled or disabled on FortiGate units that are equipped with bypass interfaces and
support AMCmodules, a new SNMP trap is generated and logs bypass events.

Implement SNMP support for NAT Session monitoring which includes new SNMP OIDs
(383661)

FortiOS 5.6 implements a new feature providing SNMP support for NAT session monitoring. The resulting new
SNMP object identifier (OID) is:

FORTINET-FORTIGATE-
MIB:fortinet.fnFortiGateMib.fgFirewall.fgFwIppools.fgFwIppTables.fgFwIppStatsTable.fgFwIppStatsEntry
1.3.6.1.4.1.12356.101.5.3.2.1.1

Additionally, there are eight new items:

.fgFwIppStatsName .1

.fgFwIppStatsType .2

.fgFwIppStatsStartIp .3

.fgFwIppStatsEndIp .4

.fgFwIppStatsTotalSessions .5

.fgFwIppStatsTcpSessions .6

.fgFwIppStatsUdpSessions .7

.fgFwIppStatsOtherSessions .8

New extended database version OIDs for AV and IPS (402162)

New extended database version OIDs ensure accurate display of the AntiVirus and IPS databases in use when
you go to System > FortiGuard.

Administrator password encryption hash upgraded from SHA1 to SHA256 (391576)

The encryption has for administrator passwords is upgraded from SHA1 to SHA256.

Downgrades from FortiOS 5.6->5.4->5.2->5.0 will keep the administrator password usable. If you need to
downgrade to FortiOS 4.3, remove the password before the downgrade, then login after the downgrade and re-
set password.

Allow multiple FortiManager addresses when configuring central management (388083)

Central management configuration can now support multiple FortiManager addresses. This feature is mainly to
help the case where the FortiGate unit is behind NAT.
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FortiGuard can determine a FortiGate's location from its public IP address (393972)

A new CLI command allows users to determine a FortiGate's location from its public IP address through
FortiGuard .

The new CLI command is diagnose sys waninfo.

Deletion of multiple saved configurations supported (308936)

The FortiGate will save multiple configurations and images when revision-backup-on-logout and
revision-image-auto-backup are enabled in config system global.

The deletion of multiple saved configurations is now possible due to changes in the CLI command execute
revision delete config <revision ID>. Where the command only allowed for one revision ID at a
time, it now allows almost ten.

New CLI option to limit script output size (388221)

The new CLI command set output-size limits the size of an auto script in megabytes and prevents the
memory from being used up by the script's output.

CLI Syntax

config system auto-script
edit <script name>

set output-size <integer>
next

end

Enter an integer value from 10 to 1024. Default is 10.

Enable / disable logging of SSL connection events (375582)

New CLI commands are added to give the user the option to enable or disable logging of SSL connection events.

CLI Syntax

config system global
set log-ssl-connection {enable | disable}

end

Default is disable.

Enabling or disabling static key ciphers (379616)

There is a new option in system global to enable or disable static key ciphers in SSL/TLS connections (e.g,.
AES128-SHA, AES256-SHA, AES128-SHA256, AES256-SHA256). The default is enable.

CLI Syntax

config system global
set ssl-static-key-ciphers {enable | disable}

end

256 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New in previous versions of FortiOS 5.6

Enhancements to IPS Signatures page (285543)

The IPS signatures list page now shows which IPS package is currently deployed. You can also change the IPS
package by hovering over the information icon next to the IPS package name. Text appears that links directly to
the FortiGate'sSystem > FortiGuard page from the IPS Signatures list page.

Combine multiple commands into a CLI alias (308921)

You can add one or more CLI command to a CLI alias, then use the alias command to run the alias that you
have created to execute the stored commands. For example, create the following alias to run the get
system status command:

config system alias
edit "version"

set command "get system status"
end

Then you can use the following command to run the alias:

alias version

You can use command abbreviations (for example: g sys stat instead of get system status). Use
quotes around the syntax if there are spaces (there usually are).

You can enter alias followed by a ? to view the aliases that you have added.

You can add multiple commands to an alias by pressing Ctrl-Enter after the first line. Press enter at the end of
subsequent lines. And the end of the last line add second quote and press Enter to end the command.

config system alias
edit "debug_flow"

set command "diag debug enable
diag debug flow show console enable"

end

You can include config commands in an alias as well, for example, create the following alias to bring the port1
and port2 interfaces down:

config system alias
edit port12down

set command "config system interface
edit port1
set status down
next
edit port2
set status down
end"

end

You can combine config, execute, get, and diagnose commands in the same alias, for example:

config system alias
edit "show-info"

set command "show full-configuration alertemail setting
get sys status
dia sys top"

end
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Traffic shaping (5.6.3)

Support schedule on traffic shaping policy (450337)

In FortiOS 5.6, a new traffic "shaping-policy" feature was added, but it lacked the ability to apply different
shaping profiles at different times. This feature addresses this issue by adding a "schedule" attribute to the
shaping policy.

This feature is currently only available via the CLI, and you can use this feature to apply a reoccurring schedule to
your traffic shaping policies. The default recurring schedule options available are always or none. You can also
create new schedules or schedule groups under Policy & Objects > Schedules. This allows you to create
custom recurring or one-time schedules that can then be applied to your traffic shaping policies using the
commands below.

Syntax

config firewall shaping-policy
edit <shaping policy ID>

set schedule {always | none}
end
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VDOMs (5.6.0)
This section describes new VDOM features added to FortiOS 5.6

Dashboard changes

The option to enable VDOMs is no longer part of the System Information widget. To enable VDOMs, you must
now go to System > Settings.

Firewall Service Cache improvement

The Firewall Service Cache will now have separate caches for each VDOM, to improve the speed of cache
searches.

VoIP/SIP (5.6)
This chapter describes new VoIP and SIP features added to FortiOS 5.6.

SIP strict-register enabled by default in VoIP Profiles (380830)

If strict-register is disabled, when REGISTER is received by a FortiGate, the source address (usually the
IP address of PBX) and ports (usually port 5060) are translated by NAT to the external address of the FortiGate
and port 65476. Pinholes are then opened for SIP and RTP. This tells the SIP provider to send incoming SIP
traffic to the external address of the FortiGate on port 65476.

This creates a security hole since the port is open regardless of the source IP address so an attacker who scans all
the ports by sending REGISTERmessages to the external IP of the FortiGate will eventually have one register go
through.

When strict-register is enabled (the new default) the pinhole is smaller because it will only accept packets
from the SIP server.

Enabling strict-register can cause problems when the SIP registrar and SIP proxy server are separate
entities with separate IP addresses.

SIP diagnose command improvements (376853)

A diagnose command has been added to the CLI that outputs VDOM data located in the voipd daemon.

diagnose sys sip-proxy vdom

Example

(global) # diagnose sys sip-proxy vdom
VDOM list by id:
vdom 0 root (Kernel: root)
vdom 1 dmgmt-vdom (Kernel: dmgmt-vdom)
vdom 2 test2 (Kernel: test2)
vdom 3 test3 (Kernel: test3)
vdom 4 vdoma2 (Kernel: vdoma2)
vdom 5 vdomb2 (Kernel: vdomb2)
vdom 6 vdomc2 (Kernel: vdomc2)
vdom 7 vdoma (Kernel: vdoma)
vdom 8 vdomb (Kernel: vdomb)
vdom 9 vdomc (Kernel: vdomc)
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VDOM list by name:
vdom 1 dmgmt-vdom (Kernel: dmgmt-vdom)
vdom 0 root (Kernel: root)
vdom 2 test2 (Kernel: test2)
vdom 3 test3 (Kernel: test3)
vdom 7 vdoma (Kernel: vdoma)
vdom 4 vdoma2 (Kernel: vdoma2)
vdom 8 vdomb (Kernel: vdomb)
vdom 5 vdomb2 (Kernel: vdomb2)
vdom 9 vdomc (Kernel: vdomc)
vdom 6 vdomc2 (Kernel: vdomc2)
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WiFi (5.6.3)
NewWiFi features added to FortiOS 5.6.3.

Allow admin with write permission to see plain text WiFi password (249787, 434513, 452834,
458211, 458285)

Add support for admins with write permission to read plain text password. Admins can view these plain text
passwords (captive-portal-radius-secret and passphrase) under config wireless-
controller vap. Note that security must be set as a WPA-personal setting.

WiFi Health Monitor page updates (392574, 392585, 404341, 417039, 434141, 440709)

TheWiFi Health Monitor page list of active clients now shows their MAC address entries (similar to theWiFi
Client Monitor page), making client information easier to view when opening the Active Clientwidget.

FortiAP LED Schedules (436227)

Support has been added for WTP profile LED schedules.

Use the command below (led-schedule) to assign recurring firewall schedules for illuminating LEDs on the
FortiAP. This entry is only available when led-state is enabled, at which point LEDs will be visible when at
least one of the schedules is valid.

Separate multiple schedule names with a space, as configured under config firewall schedule group
and config firewall schedule recurring.

Syntax

config wireless-controller wtp-profile
edit {name}

set led-state {enable | disable}
set led-schedules <name>

next
end

Sharing Tunnel SSIDs within a single managed AP between VDOMs as a Virtual AP for multi-
tenancy (439751)

Support has been added for the ability to move a tunnel mode VAP into a VDOM, similar to an interface/VLAN in
VDOMs.

FortiAP is registered into the root VDOM. Within a customer VDOM, customer VAPs can be created/added. In the
root VDOM, the customer VAP can be added to the registered FortiAP. Any necessary firewall rules and
interfaces can be configured between the two VDOMs.

Syntax

config wireless-controller global
set wtp-share {enable | disable}

end
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30D/30E models support two normal-mode FAPs (446122)

Fixed an issue that blocked FortiGate 30D and 30Emodels from supporting two normal-mode FortiAPs.

MAC Bypass for Captive Portal (448296)

Support has been added to provide a MAC address bypass for authenticated clients. Previously, when clients
were authenticated with bridged SSID and their MAC addresses were known, they were not redirected to the
External Captive Portal.

A new portal type has been added, under config wireless-controller vap, to provide successful MAC
authentication Captive Portal functionality.

Syntax

config wireless-controller vap
edit {name}

set portal-type {cmcc-macauth}
next

end

WiFi Health Monitor fixes (449341)

An issue has been addressed where the Client Countwidget (underWiFi Health Monitor) showed wrong
options for the timeline selection.

The fixes include:

l Fixed timeline selection options to correct values.
l Updated time filter parameters with correct arguments in the Login Failureswidget.
l Added local radio to AP Statuswidget details.
l Fixed Login Failureswidget, where the SSID name was improperly formatted if it contained HTML characters.

Various bug fixes (452975, 455218, 453161, 405117, 453533, 453535, 184384)

Various fixes have been implemented to address a variety of issues:

The fixes include:

l Removed code to avoid repeated printing "parse dhcp options" after upgrade or reboot.
l Removed code that supported FAP-C221E, C226E, and C21D, as their product names changed.
l Changed the text for incorrect WiFi CLI help descriptions.
l Fixed background scan settings for FAP 222C, 223C, 321C, C220C, C225C, C23JD, and C24JE.
l Set WTP entry with "discovered" state to built-in in order to skip them, as only managed FAPs can be counted

toward FAP capacity.

Configure how a FortiWiFi WiFi interface in client mode selects a WiFi band (455305)

For an FortiWiFi WiFi interface operating in client mode, you can use the following option to configure the WiFi
band that the interface can connect to. You can configure the interface to connect to any band, just to the 5G
band or to prefer connecting to the 5G band.
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Syntax

config system interface
edit {name}

set wifi-ap-band {any | 5g-preferred | 5g-only}
next

end

WiFi (5.6.1)
NewWiFi features added to FortiOS 5.6.1.

Support for various FortiAP models (416177) (435638) (424483)

FortiAP units FAP-U321EV, FAP-U323EV, FAP-S221E, FAP-S223E, FAP-222E, FAP-221E, and FAP-223E are
supported by FortiOS 5.6.1.

As part of this support, new CLI attributes have been added under config wireless-controller wtp-
profile to manage their profiles.

CLI syntax

config wireless-controller wtp-profile
edit <model>

config platform
set type <model>

end
set ap-country <code>
config radio-1

set band 802.11n
end
config radio-2

set band 802.11ac
end

next
end

New Managed AP Groups and Dynamic VLAN Assignment (436267)

The FortiGate can create FortiAPGroups, underWiFi & Switch Controller > Managed Devices > Managed
FortiAPs by selecting Create New > Managed AP Group, where multiple APs can be managed. AP grouping
allows specific profile settings to be applied to many APs all at once that belong to a certain AP group, simplifying
the administrative workload.

Note that each AP can only belong to one group.

In addition, VLANs can be assigned dynamically based on the group which an AP belongs. When defining an
SSID, underWiFi & Switch Controller > SSID, a setting called VLAN Pooling can be enabled where you
can either assign the VLAN ID of the AP group the device is connected to, to each device as it is detected, or to
always assign the same VLAN ID to a specific device. Dynamic VLAN assignment allows the same SSID to be
deployed to many APs, avoiding the need to produce multiple SSIDs.
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GUI support for configuring multiple pre-shared keys for SSID interfaces (406321)

Multiple pre-shared keys can be created per SSID. When creating a new SSID, enableMultiple Pre-shared
Keys underWiFi Settings.

FortiAP Bluetooth Low Energy (BLE) Scan (438274)

The FortiGate can configure FortiAP Bluetooth Low Energy (BLE) scan, incorporating Google's BLE beacon
profile known as Eddystone, used to identify groups of devices and individual devices.

Currently, only the FAP-S221E, FAP-S223E, and FAP-222Emodels support this
feature.

As part of this support, new CLI attributes have been added under config wireless-controller
timers and config wireless-controller wtp-profile, including a new CLI command, config
wireless-controller ble-profile.

CLI syntax - Configure BLE profiles

config wireless-controller ble-profile
edit <name>

set comment <comment>
set advertising {ibeacon | eddystone-uid | eddystone-url}
set ibeacon-uuid <uuid>
set major-id <0 - 65535> - (default = 1000)
set minor-id <0 - 65535> - (default = 1000)
set eddystone-namespace <10-byte namespace>
set eddystone-instance <device id>
set eddystone-url <url>
set txpower <0 - 12> - (default = 0)
set beacon-interval <40 - 3500> - (default = 100)
set ble-scanning {enable | disable} - (default = disable)

next
end

Note that txpower determines the transmit power level on a scale of 0-12:

0: -21 dBm 1: -18 dBm 2: -15 dBm 3: -12 dBm 4: -9 dBm

5: -6 dBm 6: -3 dBm 7: 0 dBm 8: 1 dBm 9: 2 dBm

10: 3 dBm 11: 4 dBm 12: 5 dBm

CLI syntax - Configure BLE report intervals

config wireless-controller timers
set ble-scan-report-intv - (default = 30 sec)

end

CLI syntax - Assign BLE profiles to WTP profiles

config wireless-controller wtp-profile

264 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 1 - What's New for FortiOS 5.6 What's New in previous versions of FortiOS 5.6

edit <name>
set ble-profile <name>

next
end

WiFi client monitor page search enhanced (440709)

WiFi Cient Monitor page (Monitor > WiFi Client Monitor) now supports search function.

WiFi (5.6)
NewWiFi features added to FortiOS 5.6.

Captive Portal Authentication with FortiAP in Bridge Mode (408915)

The FortiGate can operate as a web captive portal server to serve the captive portal local bridge mode.

A new CLI command has been added under config wireless-controller vap to set the captive portal
type to CMCC, a wireless cipher.

CLI syntax

config wireless-controller vap
edit <name>

set portal-type { ... | cmcc}
next

end

802.11kv(r) support (405498, 395037)

New CLI commands have been added under config wireless-controller vap to set various 802.11kvr
settings, or Voice Enterprise (802.11kv) and Fast Basic Service Set (BSS) Transition (802.11r), to provide faster
and more intelligent roaming for the client.

CLI syntax

config wireless-controller vap
edit <name>

set voice-enterprise {enable | disable}
set fast-bss-transition {enable | disable}
set ft-mobility-domain
set ft-r0-key-lifetime [1-65535]
set ft-over-ds {enable | disable}

next
end

External Captive Portal authentication with FortiAP in Bridge Mode (403115, 384872)

New CLI commands have been added under config wireless-controller vap to set various options
for external captive portal with FortiAP in Bridge Mode. The commands set the standalone captive portal server
category, the server's domain name or IP address, secret key to access the RADIUS server, and the standalone
captive portal Access Controller (AC) name.

Note that these commands are only available when local-standalone is set to enable and security is set to
captive-portal.
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CLI syntax

config wireless-controller vap
edit <name>

set captive-portal-category {FortiCloud | CMCC} Default is FortiCloud.
set captive-portal-radius-server <server>
set captive-portal-radius-secret <password>
set captive-portal-ac-name <name>

next
end

Japan DFS support for FAP-421E/423E/S421E/S423E (402287, 401434)

Korea and Japan Dynamic Frequency Selection (DFS) certification has been added for FAP-
421E/423E/S421E/S423E. DFS is a mechanism that allowsWLANs to select a frequency that does not interfere
with certain radar systems while operating in the 5 GHz band.

802.3az support on WAVE2 WiFi APs (400558)

A new CLI command has been added under config wireless-controller wtp-profile to enable or
disable use of Energy-Efficient Ethernet (EEE) on WTP, allowing for less power consumption during periods of
low data activity.

CLI syntax

config wireless-controller wtp-profile
edit <profile-name>

set energy-efficient-ethernet {enable|disable}
end

CLI command update made in wids-profile (400263)

The CLI command rogue-scan under config wireless-controller wids-profile has been
changed to sensor-mode and allows easier configuration of radio sensor mode. Note that while foreign
enables radio sensor mode on foreign channels only, both enables the feature on foreign and home channels.

CLI syntax

config wireless-controller wids-profile
edit <example>

set sensor-mode {disable|foreign|both}
end

Channel utilization, FortiPresence support on AP mode, QoS enhancement for voice (399134,
377562)

A new CLI command has been added, config wireless-controller qos-profile, to configure
quality of service (QoS) profiles where you can add WiFi multi-media (WMM) control and Differentiated Services
Code Point (DSCP) mapping.

Note that:

l call-capacity and bandwidth-admission-control are only available when call-admission-
control is set to enable.
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l bandwidth-capacity is only available when bandwidth-admission-control is set to enable.
l All DSCPmapping options are only available when dscp-wmm-mapping is set to enable.
l wmm is already set to enable by default. If wmm is set to disable, the following entries are not available: wmm-
uapsd, call-admission-control, and dscp-wmm-mapping.

CLI syntax

config wireless-controller qos-profile
edit <example>

set comment <comment>
set uplink [0-2097152] Default is 0 Kbps.
set downlink [0-2097152] Default is 0 Kbps.
set uplink-sta [0-2097152] Default is 0 Kbps.
set downlink-sta [0-2097152] Default is 0 Kbps.
set burst {enable|disable} Default is disable.
set wmm {enable|disable} Default is enable.
set wmm-uapsd {enable|disable} Default is enable.
set call-admission-control {enable|disable} Default is disable.
set call-capacity [0-60] Default is 10 phones.
set bandwidth-admission-control {enable|disable} Default is disable.
set bandwidth-capacity [1-600000] Default is 2000 Kbps.
set dscp-wmm-mapping {enable|disable} Default is disable.
set dscp-wmm-vo [0-63] Default is 48 56.
set dscp-wmm-vi [0-63] Default is 32 40.
set dscp-wmm-be [0-63] Default is 0 24.
set dscp-wmm-bk [0-63] Default is 8 16.

QoS profiles can be assigned under the config wireless-controller vap command using qos-
profile.

FortiCloud managed APs can now be applied a bandwidth restriction or rate limitation based on SSID. For
instance if guest and employee SSIDs are available, you can rate limit guest access to a certain rate to
accommodate for employees. This feature also applies a rate limit based on the application in use, as APs are
application aware.

FAP-U421E and FAP-U423E support (397900)

Two Universal FortiAPmodels support FortiOS 5.6. Their default profiles are added under config wireless-
controller wtp-profiles, as shown below:

CLI syntax

config wireless-controller wtp-profile
edit "FAPU421E-default"

config platform
set type U421E

end
set ap-country US
config radio-1

set band 802.11n
end
config radio-2

set band 802.11ac
end

next
end
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config wireless-controller wtp-profile
edit "FAPU423E-default"

config platform
set type U423E

end
set ap-country US
config radio-1

set band 802.11n
end
config radio-2

set band 802.11ac
end

next
end

Minor reorganization of WiFi GUI entries (396497)

WiFi & Switch ControllerGUI entriesManaged FortiAPs, SSID, FortiAP Profiles, andWIDS Profiles
have been reorganized.

Multiple PSK support for WPA personal (393320, 264744)

New CLI commands have been added, under config wireless-controller vap, to configure multiple
WiFi Protected Access Pre-Shared Keys (WPA-PSKs), as PSK is more secure without all devices having to share
the same PSK.

Note that, for the following multiple PSK related commands to become available, vdom, ssid, and
passhphrase all have to be set first.

CLI syntax

config wireless-controller vap
edit <example>

set mpsk {enable|disable}
set mpsk-concurrent-clients [0-65535] Default is 0.
config mpsk-key

edit key-name <example>
set passphrase <wpa-psk>
set concurrent-clients [0-65535] Default is empty.
set comment <comments>

next
end

end

Use the mpsk-concurrent-clients entry to set the maximum number of concurrent connected clients for
each mpsk entry. Use the mpsk-key configuration method to configure multiple mpsk entries.

Table size of qos-profile has VDOM limit (388070)

The command config wireless-controller qos-profile now has VDOM table limit; there is no
longer an unlimited number of entries within each VDOM.
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Add "dhcp-lease-time" setting to local-standalone-nat VAP (384229)

When a Virtual Access Point (VAP) has been configured for a FortiAP, a DHCP server is automatically configured
on the FortiAP side with a hard lease time. A new CLI command under config wireless-controller
vap has been added to customize the DHCP lease time for NAT IP address. This is to solve issues where the
DHCP IP pool was exhausted when the number of clients grew too large for the lease time span.

Note that the new command, dhcp-lease-time, is only available when local-standalone is set to
enable, then setting local-standalone-nat to enable.

CLI syntax

config wireless-controller vap
edit <example>

set local-standalone {enable|disable}
set local-standalone-nat {enable|disable}
set dhcp-lease-time [300-8640000] Default is 2400 seconds.

end

New CLI command to configure LDPC for FortiAP (383864)

Previously, LDPC value on FortiAP could only be changed on FortiAP local CLI. Syntax has been added in
FortiOS CLI under the 'wireless-controller.vap' entry to configure the LDPC value on FortiAP.

CLI Syntax

configure wireless-controller vap
edit 1

set ldpc [enable|rx|tx|disable]
end

New region code/SKU for Indonesia (382926)

A new country region code, F, has been added to meet Indonesia's WiFi channel requirements. Indonesia
previously belonged to region code W.

FortiAP RMA support added (381936)

New CLI command fortiap added under exe replace-device to replace an old FortiAP's serial number
with a new one.

CLI Syntax

execute replace-device fortiap <old-fortiap-id> <new-fortiap-id>

Support fixed-length 64-hex digit for WPA-Personal passphrase (381030)

WPA-Personal passphrase now supports a fixed-length of 64 hexadecimal digits.

Allow FortiGates to manage cloud-based FortiAPs (380150)

FortiGates can now manage cloud-based FortiAPs using the new fapc-compatibility command under
wireless-controller setting.
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If enabled, default FAP-C wtp-profiles will be added. If disabled, FAP-C related CMDB configurations will be
removed: wtp-group in vap's vlan-pool, wtp-group, ws, wtp, wtp-profile.

CLI syntax

config wireless-controller setting
set country CN
set fapc-compatibility [enable|disable]

end

You will receive an error message when trying to change country while fapc-
compatibility is enabled. You need to disable fapc-compatibility before
changing to an FAPC unsupported country.

Use IPsec instead of DTLS to protect CAPWAP tunnels (379502)

This feature is to utilize FortiAP hardware to improve the throughput of tunneled data traffic by using IPsec when
data security is enabled.

"AES-256-CBC & SHA256" algorithm and "dh_group 15" are used for both CAPWAP IPsec phase1 and phase 2.

FAP320B will not support this feature due to its limited capacity of free flash.

New option added to support only one IP per one endpoint association (378207)

When users change configuration, the radiusd will reset all configurations and refresh all logons in the kernel. All
these actions are done in the one loop. A CLI option has been added to enable/disable replacement of an old IP
address with a new IP address for the same endpoint on RADIUS accounting start.

CLI Syntax

configure user radius
edit radius-root

set rsso-ep-one-ip-only [enable|disable]
next

end

FAP-222C-K DFS support (377795)

Dynamic Frequency Selection (DFS) bands can now be configured for FortiAP 222C-K.

Note that this FortiAPmodel has the Korean region code (K), but ap-country under config wireless-
controller wtp-profile still needs to be set to KR.

CLI syntax

config wireless-controller wtp-profile
edit <K-FAP222C>

config platform
set type <222C>

end
set ap-country KR
config radio-2

set band <802.11ac>
set vap-all <disable>
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set vaps "vap-vd-07"
set channel "52" "56" "60" "64" "100" "104" "108" "112" "116" "120" "124" "128"

"132" "136" "140"
end

next
end

Dynamic VLAN support in standalone mode (377298)

Dynamic VLAN is now supported in standalone mode. Previously, dynamic VLAN only worked in local bridge
mode.

CLI-only features added to GUI (376891)

Previously CLI-only features have been added to the GUI under FortiAP Profiles, Managed FortiAPs, and
SSID. Also fixed issue where the correct value is displayed when viewing theWIDS Profile notification icon
under FortiAP Profiles.

Managed AP GUI update (375376)

Upgraded Managed FortiAPs dialog page to a newer style, including icons for SSID and LAN port.

Bonjour gateway support (373659)

Bonjour gateway now supported for WiFi networks.

Syntax
config wireless-controller bonjour-profile

edit 0
set comment "comment"
config policy-list

edit 1
set description "description"
set from-vlan [0-4094] Default is 0.
set to-vlan [0-4094|all] Default is all.
set services [all|airplay|afp|bit-

torrent|ftp|ichat|itunes|printers|samba|scanners|ssh|chromecast]
next

end
next

end

FAP421E/423E wave2 support (371374)

Previously removed wave2 FAP421E and FAP423Emodels have been reinstated and are now supported again.
The models are available again through the CLI and GUI. These models are listed under the Platform dropdown
menu when creating a new FortiAP Profile underWiFi & Switch Controller > FortiAP Profiles.

CLI syntax

config wireless-controller wtp-profile
edit <example>
config platform

set type <...|421E|423E>
end

end
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WiFi Health Monitor GUI changes (308317)

The Wifi Health Monitor page has been improved, including the following changes:

l Flowchart used for diagrams
l Chart used for interference and AP clients
l Removed spectrum analysis
l Added functionality to upgrade FortiAP firmware
l Added option to view both 2.4GHz and 5GHz data simultaneously

AP Profile GUI page updates (298266)

The AP Profile GUI page has been upgraded to a new style including AngularJS code.

1+1 Wireless Controller HA (294656)

Instances of failover between FortiAP units was too long and lead to extended periods of time where WiFi users
were without network connection. Because WiFi is considered a primary network connection in today's verticals
(including enterprise, retail, education, warehousing, healthcare, government, and more), it is necessary for
successful failover to occur as fast as possible.

You can now define the role of the primary and secondary controllers on the FortiAP unit, allowing the unit to
decide the order in which the FortiAP selects the FortiGate. This process was previously decided on load-based
detection, but can now be defined by each unit's pre-determined priority. In addition, heartbeat intervals have
been lowered to further improve FortiAP awareness and successful failover.

Syntax

config wireless-controller inter-controller
set inter-controller-mode {disable | l2-roaming | 1+1} Default is disable.
set inter-controller-key <password>
set inter-controller-pri {primary | secondary} Default is primary.
set fast-failover-max [3-64] Default is 10.
set fast-failover-wait [10-86400] Default is 10.
config inter-controller-peer

edit <name>
set peer-ip <ip-address>
set peer-port [1024-49150] Default is 5246.
set peer-priority {primary | secondary} Default is primary.

next
end

end

Support for duplicate SSID names on tunnel and bridge mode interfaces (278955)

When duplicate-ssid is enabled in the CLI, this feature allows VAPs to use the same SSID name in the
same VDOM. When disabled, all SSIDs in WLAN interface will be checked—if duplicate SSIDs exist, an error
message will be displayed. When duplicate-ssid is enabled in the CLI, duplicate SSID check is removed in
"Edit SSID" GUI page.

Syntax

config wireless-controller setting
set duplicate-ssid [enable|disable]
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next
end

Controlled failover between wireless controllers (249515)

Instances of failover between FortiAP units was too long and lead to extended periods of time where WiFi users
were without network connection. Because WiFi is considered a primary network connection in today's verticals
(including enterprise, retail, education, warehousing, healthcare, government, and more), it is necessary for
successful failover to occur as fast as possible.

Administrators can now define the role of the primary and secondary controllers on the FortiAP unit, allowing the
unit to decide the order in which the FortiAP selects the FortiGate. This process was decided on load-based
detection, but can now be defined by each unit's pre-determined priority. In addition, heartbeat intervals have
been lowered to further improve FortiAP awareness and successful failover.
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Getting started

This guide explains how to get started with a FortiGate, and examines basic configuration tasks and best
practices in these sections:

l Installation discusses installing a FortiGate in your network.
l Using the GUI highlights features of the graphical user interface (GUI).
l Using the CLI provides a high level overview of the command line interface (CLI) for FortiOS.
l FortiExplorer for iOS provides instructions for connecting to a FortiGate using the FortiExplorer for iOS app.
l FortiGate Inspection Mode summarizes proxy-based and flow-based inspection modes.
l FortiGate LED Specifications presents a short guide to LED status indicators.
l Basic Administration explains basic tasks for setting up a new FortiGate and for updating firmware.
l Resources provides a list of documents to help you with more advanced FortiGate configurations.

Differences between Models
Before you get started, note that not all FortiGate models have the same features. This is especially true of the
desktop or entry-level models: FortiGate / FortiWiFi models 30 to 90. If you are using one of these FortiGate
models, you may have some difficulties accessing certain features.

Preliminary information on entry-level models is available below:

The entry-level, or desktop, models can connect to the internet in two simple steps. They also have a number of
features that are only available using the CLI, rather than appearing in the GUI.

l Quick installation using DHCP
l CLI-only features

Consult your model's Quick Start Guide, hardware manual, or the Feature / Platform
Matrix for further information about features that vary by model.

Fortinet's Cookbook site has a section on hardware that provides how-to recipes and articles on features that are
unique to certain models.

FortiGate models differ principally by the names used and the features available:

l Naming conventions may vary between FortiGate models. For example, on some models the hardware switch
interface used for the local area network is called lan, while on other units it is called internal.

l Certain features are not available on all models. Additionally, a particular feature may be available only through the
CLI on some models, while that same feature may be viewed in the GUI on other models.

If you believe your FortiGate model supports a feature that does not appear in the GUI, go to System
> Feature Visibility and confirm that the feature is enabled. For more information, see Feature Visibility on
page 300.
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What's New in FortiOS 5.6

This chapter describes new features added to FortiOS 5.6.0, 5.6.1, and 5.6.3.

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Administrator password changes (414927)

The existing Change Password dialog that appears in the GUI is updated to reflect the new look of the password
change prompt at login.

l Added inline validation for checking password policy and password reuse
l Changed style to match new login prompt password change
l Fixed issue where fDialog would close slide out on submission failure

Support FortiOS to allow user to select domain when logging a FG into FortiCloud (452350)

Support has been added to show a list of all possible FortiCloud domains that the FortiGate can be served by.

Syntax

execute fortiguard-log domain

This command is typically used for testing purposes, and so it will not appear when entering execute
fortiguard-log ?.

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

VM License visibility improvement (423347)

VM License GUI items have changed as follows:

l Added VM widget toGlobal > Dashboard. Includes the following:

l License status and type.
l CPU allocation usage.
l License RAM usage.
l VMX license information (if the VM supports VMX).
l If the VM license specifies 'unlimited' the progress bar is blank.
l If the VM is in evaluation mode, it is yellow (warning style) and the dashboard show evaluation days used.

l Widget is shown by default in the dashboard of a FortiOS VM device.
l Removed VM information from License widget at Global > Dashboard.
l License info and Upload License button provided on pageGlobal > System > FortiGuard.
l Updated 'Upload VM License' page:
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l Added license RAM usage and VMX instance usage.
l Replaced file input component.

CLI Syntax

config sys admin
edit <name>

config gui-dashboard
edit <1>

set name <name>
config widget

edit <2>
set type {vminfo | ...} <- new option
set x-pos <2>
set y-pos <1>
set width <1>
set height <1>

next
end

next
end

next
end

FortiView Dashboard Widget (434179)

Added a new widget type to the dashboard for top level FortiView. FortiView widgets have report-by, sort-by,
visualization, timeframe properties, and filters subtable in the CLI.

Supported FortiViews include Source, Destination, Application, Country, Interfaces, Policy, Wifi Client, Traffic
Shaper, Endpoint Vulnerability, Cloud User, Threats, VPN, Websites, and Admin and System Events.

Bubble, table, chord chart, and country visualizations are supported in the widget.

Widgets can be saved from a filtered FortiView page on to a dashboard.

Syntax

config system admin
config gui-dashboard

config widget
set type fortiview
set report-by {source | destination | country | intfpair | srcintf | dstintf |

policy | wificlient | shaper | endpoint | application | cloud | web | threat
| system | unauth | admin | vpn}

set timeframe {realtime | 5min | hour | day | week}
set sort-by <string>
set visualization {table | bubble | country | chord}
config filters

set key <filter_key>
set value <filter_value>
end

end
end

end
end
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Where:

l report-by = Field to aggregate the data by.
l timeframe = Timeframe period of reported data.
l sort-by = Field to sort the data by.
l visualization = Visualization to use.

Controls added to GUI CLI console (422623)

FortiOS 5.6.1 introduces new options in the browser CLI console to export the console history. Options are now
available to Clear console, Download, and Copy to clipboard.

FortiExplorer icon enhancement (423838)

FortiOS icons and colors are now exportable in the GUI shared project and FortiExplorer now uses these icons
and colors. This change improves the icon colors only for the FortiExplorer GUI theme (seen only when accessing
a web GUI page from within the FortiExplorer iOS app).

The following locations were affected: Policy List, Policy Dialogue, Address List, Address Dialogue, Virtual IP list,
Virtual IP Dialogue.

FortiOS 5.6
These features first appeared in FortiOS 5.6.

The FortiOS 5.6 Dashboard has a new layout with a Network Operations Center (NOC) view with a focus on
alerts. Widgets are interactive; by clicking or hovering over most widgets, the user can get additional information
or follow links to other pages.

Enhancements to the GUI dashboard and its widgets are:

l Multiple dashboard support.
l VDOM and global dashboards.
l Updated resize control for widgets.
l Notifications moved to the top header bar (moved existing dashboard notifications to the header and added

additional ones).
l Reorganization of Add Widget dialog.
l NewHost Scan Summarywidget.
l New Vulnerabilities Summarywidget that displays endpoint vulnerability information much like the FortiClient

Enterprise Management Server (EMS) summary.
l Multiple bug fixes.
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Features that were only visible through old dashboard widgets have been placed elsewhere in the GUI:

l Restore configuration.
l Configuration revisions.
l Firmware management.
l Enabling / disabling VDOMs.
l Changing inspection mode.
l Changing operation mode.
l Shutdown / restart device.
l Changing hostname.
l Changing system time.

The followingwidgets are displayed by default:

l System Information
l Licenses
l FortiCloud
l Security Fabric
l Administrators
l CPU
l Memory
l Sessions
l Bandwidth
l Virtual Machine (on VMs and new to FortiOS 5.6.1)

The following optional widgets are available:

l Interface Bandwidth
l Disk Usage
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l Security Fabric Risk
l Advanced Threat Protection Statistics
l Log Rate
l Session Rate
l Sensor Information
l HAStatus
l Host Scan Summary
l Vulnerabilities Summary
l FortiView (new to FortiOS 5.6.1)

The following widgets have been removed:

l CLI Console
l Unit Operation
l Alert Message Console

System Information

FortiGuard WAN IP blacklist service is now online

The Fortiguard WAN IP blacklist service was not online in FortiOS 5.6.0. In FortiOS 5.6.1, a notification appears
on the Dashboard when WAN IP is blacklisted. Clicking on the notification (bell icon) brings up the blacklist
details.
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Licenses

Hovering over the Licenseswidget will cause status information (and, where applicable, database information)
on the licenses to be displayed for FortiCare Support, IPS & Application Control, AntiVirus,Web
Filtering, Mobile Malware, and FortiClient. The image below shows FortiCare Support information along
with the registrant's company name and industry.

Clicking in the Licenseswidget will provide you with links to other pages, such asSystem > FortiGuard or
contract renewal pages.

FortiCloud

This widget displays FortiCloud status and provides a link to activate FortiCloud.
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Fortinet Security Fabric

The Security Fabricwidget is documented in the Security Fabric section of theWhat's New document.

Administrators

This widget allows you to view which administrators are logged in and how many sessions are active. The link
directs you to a page displaying active administrator sessions.

CPU

The real-time CPU usage is displayed for different timeframes.
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Memory

Real-time memory usage is displayed for different time frames. Hovering over any point on the graph displays
percentage of memory used along with a timestamp.
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Sessions

Bandwidth
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Virtual Machine

FortiOS 5.6.1 introduces a VM widget with these features:

l License status and type.
l CPU allocation usage.
l License RAM usage.
l VMX license information (if the VM supports VMX).
l If the VM license specifies 'unlimited' the progress bar is blank.
l If the VM is in evaluation mode, it is yellow (warning style) and the dashboard show evaluation days used.

l Widget is shown by default in the dashboard of a FortiOS VM device.
l Removed VM information from License widget at Global > Dashboard.
l License info and Upload License button provided on pageGlobal > System > FortiGuard.
l Updated 'Upload VM License' page:

l Added license RAM usage and VMX instance usage.
l Replaced file input component.

Changing inspection modes (flow-based or proxy-based)
To change inspection modes, go to System > Settings and scroll down to Inspection Mode. You can select
Flow-based to operate in Flow mode or Proxy to operate in Proxy mode. Flow-based inspection is the default
inspection mode for FortiOS 5.6.
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Transparent Web proxy mode
In proxy mode, FortiOS 5.6 functions just like FortiOS 5.4 with the addition of the new Transparent Web Proxy
mode. See Transparent web proxy (386474) on page 88.

NGFW profile-based and NGFW policy-based modes
When you use Flow-based as the Inspection Mode, you have the option in FortiOS 5.6 to select an NGFW
Mode. Profile-basedmode works the same as flow-based mode did in FortiOS 5.4

Flow-based inspection with profile-based NGFW mode is the default in FortiOS 5.6.

In the newNGFW Policy-basedmode, you add applications and web filtering profiles directly to a policy without
having to first create and configure Application Control or Web Filtering profiles. When selecting NGFW policy-
based mode you can also select the SSL/SSH Inspection mode that is applied to all policies. See NGFW Policy
Mode (397035) on page 96.

When you use flow-based inspection, all proxy mode profiles are converted to flow mode, removing any proxy
settings. And proxy-mode only features (for example, Web Application Profile) are removed from the GUI.

If your FortiGate has multiple VDOMs, you can set the inspection mode independently for each VDOM. Go to
System > VDOM. ClickEdit for the VDOM you wish to change and select the Inspection Mode.

CLI syntax

The following CLI commands can be used to configure inspection and policy modes:

config system settings
set inspection-mode {proxy | flow}
set policy-mode {standard | ngfw}

end

Change to CLI console (396225)

The CLI Console widget has been removed from FortiOS 5.6.0. It is accessed from the upper-right hand corner of
the screen and is no longer a pop-out window but a sliding window.

System Information Dashboard widget WAN IP Information enhancement (401464)

WAN IP and location data are now available in the System Information widget. Additionally, If the WAN IP is
blacklisted in the FortiGuard server, there will be a notification in the notification area, located in the upper right-
hand corner of the Dashboard. Clicking on the notification will open the WAN IP Blacklisted slider with the
relevant blacklist information.
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CLI and GUI changes to display FortiCare registration information (395254)

The changes pertain to industry and organization size of the FortiGate's registered owner.

GUI Changes

l Add industry and organization size to FortiCare registration page
l Add company and industry to license widget tooltip for FortiCare

When you hover over the Licenses widget in the FortiOS 5.6 dashboard, you can see the company and industry
data, provided it has been entered in the FortiCare profile.

CLI Changes

Commands are added to diagnose forticare

dia forticare direct-registration product-registration -h
Options: a:A:y:C:c:T:eF:f:hI:i:l:O:o:p:P:z:R:r:S:s:t:v:

--&lt;long&gt; -&lt;short&gt;
account_id a:
address A:
city y:
company C:
contract_number c:
country_code T:
existing_account e
fax F:
first_name f:
help h
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industry I:
industry_id i:
last_name l:
orgsize O:
orgsize_id o:
password p:
phone P:
postal_code z:
reseller R:
reseller_id r:
state S:
state_code s:
title t:
version v:

Improved GUI for Mobile Screen Size & Touch Interface (355558)

The FortiOS web GUI on mobile screens and include functionality for touch interfaces like tap to hold are
improved.

Setup Wizard removed

Previously, the Setup Wizard could be launched from the web GUI by selecting the button, located in the top
right corner. This button and the wizard in question has been removed.
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Installation

This section discusses how to install your FortiGate and use it in your network, after completion of the initial setup
outlined in the FortiGate model’s Quick Start Guide.

The following topics are included in this section:

l Quick installation using DHCP
l Installing a FortiGate in NAT mode
l Using a Virtual Wire Pair
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Quick installation using DHCP
Most of the FortiGate desktop models have a default configuration that includes a DHCP server on the lan (or
internal) interface and a security policy that securely allows all sessions from the internal network to reach the
Internet. Because of this, you can connect your desktop FortiGate to the Internet in two simple steps:

Note that, in order to use this installation method, your ISPmust provide connectivity
with DHCP and accept DHCP requests without authentication. You must also use IPv4
to connect your FortiGate to the Internet.

1. Connect the FortiGate'swan interface to your ISP-supplied equipment, and connect the internal network to the
FortiGate’s default lan interface. Turn on the ISP’s equipment, the FortiGate, and the computers on the internal
network.

2. For computers on the internal network:

a. Windows Vista/7/8/10 users:

i. Go to Network and Sharing Center and select Change adapter settings.
ii. Open the Local Area Connection (Ethernet or Wi-Fi, whichever applies) and select Properties.
iii. Select Internet Protocol Version 4 (TCP/IPv4) and then select Properties.
iv. Select Obtain an IP address automatically andObtain DNS server address automatically.
v. ClickOK.

b. Mac OS X users:

i. Go to System Preferences > Network and select your Ethernet connection.
ii. Set Configure IPv4 to Using DHCP.

Results

From any computer on the internal network, open a web browser and browse to any website to confirm successful
Internet connectivity.
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Installing a FortiGate in NAT mode
There are two main ways to install a FortiGate using network address translation (NAT)/Route mode: Standard
installation in NAT mode, where Internet access is provided by a single Internet service provider (ISP), and
Redundant Internet installation, where two ISPs are used.

NAT mode vs. Transparent mode

A FortiGate can operate in one of two modes: NAT or Transparent.

The most common of the two operating modes is NAT mode, where a FortiGate is installed as a gateway or
router between two networks. In most cases, it is used between a private network and the Internet. This allows
the FortiGate to hide the IP addresses of the private network using NAT. NAT mode is also used when two or
more ISPs provide the FortiGate with redundant Internet connections.

A FortiGate in Transparent mode is installed between the internal network and the router. In this mode, the
FortiGate does not make any changes to IP addresses and only applies security scanning to traffic. When a
FortiGate is added to a network in Transparent mode, no network changes are required, except to provide the
FortiGate with a management IP address. Transparent mode is used primarily when there is a need to increase
network protection but changing the configuration of the network itself is impractical.

For more information about Transparent Mode, see the Transparent Mode handbook.

Standard installation in NAT mode

In this configuration, a FortiGate is installed as a gateway or router between a private network and the Internet.
By using NAT, the FortiGate is able to hide the IP addresses of the private network.

Redundant Internet installation

In this configuration, a WAN link interface is created that provides the FortiGate with redundant Internet
connections from two ISPs. The WAN link interface combines these two connections, allowing the FortiGate to
treat them as a single interface.
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Installing a FortiGate with Redundant Internet

If you have previously configured your FortiGate using the standard installation, you
will have to delete all routes and policies referring to an interface that will be used to
provide redundant Internet. This includes the default Internet access policy that is
included on many FortiGate models.

1. Connect your ISP devices to your FortiGate’s Internet-facing interfaces (typically WAN1 and WAN2).
2. Go to Network > SD-WAN to create a WAN link interface, which is used to group multiple Internet connections

together so that the FortiGate can treat them as a single interface.
3. Set the interface'sStatus to Enable.
4. Under Interface, select Create New. Add WAN1 and enter the Gateway IP provided by your primary ISP. Do the

same for WAN2, but use the Gateway IP provided by your secondary ISP.
5. Select an appropriate method for the SD-WAN Usage from the following options, and Apply your changes when

finished:
l Bandwidth - A bandwidth cap is defined for active members of the SDWAN link.
l Volume - A volume ratio is set for each active member.
l Sessions - A sessions ratio is set for each active member.

6. Go to Network > Static Routes and create a new default route. Set Interface to the SD-WAN link.
7. Go to Policy & Objects > IPv4 Policy and select Create New to add a security policy that allows users on the

private network to access the Internet.
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Using a Virtual Wire Pair
A virtual wire pair consists of two interfaces that do not have IP addressing and are treated similar to a
transparent mode VDOM. All traffic received by one interface in the virtual wire pair can only be forwarded out the
other interface, provided that a virtual wire pair firewall policy allows this traffic. Traffic from other interfaces
cannot be routed to the interfaces in a virtual wire pair.

Virtual wire pairs are useful for atypical topologies where MAC addresses do not behave normally. For example,
port pairing can be used in a Direct Server Return (DSR) topology where the response MAC address pair may not
match the request’s MAC address pair.

Virtual wire pairing replaces the port pairing feature available in earlier firmware versions. Unlike port pairing,
virtual wire pairing can be used for FortiGates in both NAT and Transparent modes.

In the example configuration below, a virtual wire pair (consisting of port3 and port4) makes it easier to protect a
web server that is behind a FortiGate operating as an Internal Segmentation Firewall (ISFW). Users on the
internal network will access the web server through the ISFW over the virtual wire pair.

Adding a virtual wire pair and virtual wire pair policy

Interfaces used in a virtual wire pair cannot be used to access the ISFW FortiGate.
Before creating a virtual wire pair, make sure you have a different port configured to
allow admin access using your preferred protocol.

1. Go to Network > Interfaces and select Create New > Virtual Wire Pair.
2. Select the interfaces to add to the virtual wire pair. These interfaces cannot be part of a switch, such as the default

lan/internal interface.
3. (Optional) If desired, enableWildcard VLAN.
4. Select OK.
5. Go to Policy & Objects > IPv4 Virtual Wire Pair Policy, select the virtual wire pair, and select Create New.
6. Select the direction that traffic is allowed to flow.
7. Configure the other firewall options as desired.
8. Select OK.
9. If necessary, create a second virtual wire pair policy to allow traffic to flow in the opposite direction.
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If you have a USB-wan interface, it will not be included in the interface list when
building a wired-pair.

Results

Traffic can now flow through the FortiGate using the virtual wire pair.
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This section presents an introduction to the FortiGate's graphical user interface (GUI), also called the web-based
manager.

The following topics are included in this section:

l Connecting to the GUI using a web browser
l Menus
l Dashboard
l Feature Visibility
l Tables
l Text Strings

Connecting to the GUI using a web browser

The graphical user interface is best displayed using a 1280 x 1024 resolution. Check
the FortiOS Release Notes for information about browser compatibility.

In order to connect to the GUI using a web browser, an interface must be configured to allow administrative
access over HTTPS or over both HTTPS and HTTP. By default, an interface has already been set up that allows
HTTPS access, with the IP address 192.168.1.99.

Browse to https://192.168.1.99 and enter your username and password. If you have not changed the admin
account’s password, use the default user name, admin, and leave the password field blank.

The GUI will now be displayed in your browser.

If you wish to use a different interface to access the GUI, do the following:

1. Go to Network > Interfaces and edit the interface you wish to use for access. Take note of its assigned IP
address.

2. Beside Administrative Access, select HTTPS, and any other protocol you require. You can also select HTTP,
although this is not recommended as the connection will be less secure.

3. Select OK.
4. Browse to the IP address using your chosen protocol.

Results

The GUI will now be displayed in your browser.

294 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

https://docs.fortinet.com/document/fortigate/5.6.8/fortios-release-notes
https://192.168.1.99/


Using the GUI

Menus

If you believe your FortiGate model supports a menu that does not appear in the GUI
as expected, go to System > Feature Visibility and ensure the feature is enabled.
For more information, see "Feature Visibility" on page 300.

The GUI contains the following main menus, which provide access to configuration options for most FortiOS
features:

Dashboard The dashboard displays various widgets that display important system
information and allow you to configure some system options.

For more information, see "Dashboard" on page 297.

Security Fabric Access the physical topology, logical topology, audit, and settings features
of the Fortinet Security Fabric.

For more information, see the Fortinet Security Fabric guide.

FortiView A collection of dashboards and logs that give insight into network traffic,
showing which users are creating the most traffic, what sort of traffic it is,
when the traffic occurs, and what kind of threat the traffic may pose to the
network.

For more information, see the FortiView handbook.

Network Options for networking, including configuring system interfaces and
routing options.

For more information, see the Networking handbook.

System Configure system settings, such as administrators, FortiGuard, and
certificates.

For more information, see the System Administration handbook.

Policy & Objects Configure firewall policies, protocol options, and supporting content for
policies, including schedules, firewall addresses, and traffic shapers.

For more information, see the Networking handbook.

Security Profiles Configure your FortiGate's security features, including AntiVirus, Web
Filtering, and Application Control.

For more information, see the Security Profiles handbook.

VPN Configure options for IPsec and SSL virtual private networks (VPNs).

For more information, see the IPsec VPN and SSL VPN handbooks.
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User & Device Configure user accounts, groups, and authentication methods, including
external authentication and single sign-on (SSO).

WiFi & Switch Controller Configure the unit to act as a wireless network controller, managing the
wireless Access Point (AP) functionality of FortiWiFi and FortiAP units.

On certain FortiGate models, this menu has additional features allowing
for FortiSwitch units to be managed by the FortiGate.

For more information, see the FortiWiFi and FortiAP Configuration Guide
handbook.

Log & Report Configure logging and alert email as well as reports.

For more information, see the Logging and Reporting handbook.

Monitor View a variety of monitors, including the Routing Monitor, VPN monitors for
both IPsec and SSL, monitors relating to wireless networking, and more.
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Dashboard
The FortiOSDashboard consists of a network operations center (NOC) view with a focus on alerts. Widgets are
interactive; by clicking or hovering over most widgets, the user can get additional information or follow links to
other pages.

The dashboard and its widgets include:

l Multiple dashboard support.
l VDOM and global dashboards.
l Widget resize control.
l Notifications on the top header bar.

The following widgets are displayed by default:

Widget Description

System Information The System Information widget lists information relevant to the FortiGate
system, including Hostname, Serial Number, and Firmware.

Security Fabric The Security Fabricwidget is documented in the Fortinet Security Fabric guide.

CPU The real-time CPU usage is displayed for different time frames.
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Widget Description

License Status Hovering over the Licenseswidget will display status information (and, where
applicable, database information) on the licenses for FortiCare Support, IPS &
Application Control, AntiVirus,Web Filtering, Mobile Malware, and
FortiClient.

Clicking in the Licenseswidget will provide you with links to other pages, such as
System > FortiGuard or contract renewal pages.

FortiCloud This widget displays FortiCloud status and provides a link to activate FortiCloud.

Administrators This widget allows you to view which administrators are logged in and how many
sessions are active. The link directs you to a page displaying active administrator
sessions.

Memory Real-time memory usage is displayed for different time frames. Hovering over any
point on the graph displays percentage of memory used along with a timestamp.

Sessions Hovering over the Sessionswidget allows you to view memory usage data over
time. Click on the down-arrow to change the timeframe displayed.

SPU (Security Processing Unit) percentage is displayed if your FortiGate includes
an SPU. Likewise, nTurbo percentage is displayed if supported by your
FortiGate. See the Hardware Acceleration chapter for details.

Bandwidth Hover over the Bandwidth widget to display bandwidth usage data over time.
Click on the down-arrow to change the timeframe displayed.

Bandwidth is displayed for both incoming and outgoing traffic.

Virtual Machine The VM widget (shown by default in the dashboard of a FortiOS VM device)
includes:

l License status and type
l CPU allocation usage
l License RAM usage
l VMX license information (if the VM supports VMX)

If the VM license specifies 'unlimited' the progress bar is blank. If the VM is in
evaluation mode, it is yellow (warning style) and the dashboard show evaluation
days used.

The following optional widgets are also available:

l FortiView
l Host Scan Summary
l Vulnerabilities Summary
l Botnet Activity
l HAStatus
l Log Rate
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l Session Rate
l Security Fabric Score
l Advanced Threat Protection Statistics
l Interface Bandwidth
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Feature Visibility
Feature Visibility is used to control which features are visible in the GUI. This allows you to hide features that are
not being used. Some features are also disabled by default and must be enabled in order to configure them
through the GUI.

Feature Visibility only alters the visibility of these features, rather than their functionality. For example, disabling
web filtering on the Feature Visibility page does not remove web filtering from the FortiGate, but removes the
option of configuring web filtering from the GUI. Configuration options will still be available using the CLI.

Enabling/disabling features

Feature Visibility can be found at System > Feature Visibility. Ensure that all features you wish to configure in
the GUI are turned on, and that features you wish to hide are turned off. When you have finished, select Apply.

Security Features Presets

The main Security Features can be toggled individually, however six system presets (or Feature Sets) are
available:

l NGFW should be chosen for networks that require application control and protection from external attacks.
l ATP should be chosen for networks that require protection from viruses and other external threats.
l WF should be chosen for networks that require web filtering.
l NGFW + ATP should be chosen for networks that require protection from external threats and attacks.
l UTM should be chosen for networks that require protection from external threats and wish to use security features

that control network usage. This is the default setting.
l Custom should be chosen for networks that require customization of available features (including the ability to

select all features).
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Tables
Many of the GUI pages contain tables of information that you can filter to display specific information.
Administrators with read and write access can define the filters.

Navigation

Some tables contain information and lists that span multiple pages. Navigation controls appear at the bottom of
the page.

Filters

Filters are used to locate a specific set of information or content within multiple pages. These are especially
useful in locating specific log entries. The specific filtering options vary, depending on the type of information in
the log.

To create a filter, select Add Filter at the top of the page. A list of the available fields for filtering will be shown.

Column settings

Column settings are used to select the types of information displayed on a certain page. Some pages have large
amounts of information available and not all content can be displayed on a single screen. Some pages may even
contain content that is irrelevant to you. Using column settings, you can choose to display only relevant content.

To view configure column settings, right-click the header of a column and select the columns you wish to view and
de-select any you wish to hide. After you have finished making your selections, clickApply (you may need to
scroll down the list to do so).

Any changes that you make to the column settings are stored in the unit’s configuration. To return columns to the
default state for any given page, right-click any header and select Reset Table.

Copying objects

In tables containing configuration objects, such as the policy table found at Policy & Objects > IPv4 Policy,
you have the option to copy an object. This allows you to create a copy of that object, which you can then
configure as needed. You can also reverse copy a policy to change the direction of the traffic impacted by that
policy.

To copy an object:

1. Select that object, then right-click to make a menu appear and select the Copy option.
2. Right-click the row in the table that is either above or below where you want the copied object to be placed, select

the Paste option and indicate Above orBelow.
Reverse cloning works much the same way. Instead of selecting Copy, you will select Clone Reverse.

Once the policy is copied, you must give it a name, configure as needed, and enable it.

Editing objects

Some tables allow you to edit parts of the configuration directly on the table itself. For example, security features
can be added to an existing firewall policy from the policy list by clicking on the plus sign in the Security Profiles
column and selecting the desired profiles.
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If this option is not immediately available, check to see that the column is not hidden (see Column settings).
Otherwise, you must select the object and open the policy by selecting the Edit option found at the top of the
page.
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Text Strings
The configuration of a FortiGate is stored in the FortiOS configuration database. To change the configuration,
you can use the GUI or CLI to add, delete, or change configuration settings. These changes are stored in the
database as you make them. Individual settings in the configuration database can be text strings, numeric
values, selections from a list of allowed options, or on/off (enable/disable) settings.

Entering text strings (names)

Text strings are used to name entities in the configuration. For example, the name of a firewall address, the
name of an administrative user, and so on. You can enter any character in a FortiGate configuration text string,
except the following characters that present Cross-Site Scripting (XSS) vulnerabilities:

l “ (double quote)
l & (ampersand)
l ' (single quote)
l < (less than)
l > (greater than)

Most GUI text string fields make it easy to add an acceptable number of characters and prevent you from adding
the XSS vulnerability characters.

There is a different character limitation for VDOM names and hostnames. The only
valid characters are numbers (0-9), letters (a-z, A-Z), and special characters - (dash)
and _ (underscore).

From the CLI, you can also use the tree command to view the number of characters that are allowed in a name
field. For example, firewall address names can contain up to 64 characters. When you add a firewall address to
the GUI, you are limited to entering 64 characters in the firewall address name field. From the CLI you can enter
the following tree command to confirm that the firewall address name field allows 64 characters.

config firewall address
tree
-- [address] --*name (64)
|- uuid
|- subnet
|- type
|- start-ip
|- end-ip
|- fqdn (256)
|- country (3)
|- cache-ttl (0,86400)
|- wildcard
|- comment
|- visibility
|- associated-interface (36)
|- color (0,32)
|- [tags] --*name (65)
+- allow-routing

The tree command output also shows the number of characters allowed for other firewall address name
settings. For example, the fully qualified domain name (fqdn) field can contain up to 256 characters.
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Entering numeric values

Numeric values set various sizes, rates, addresses, and other numeric values (e.g. a static routing priority of 10, a
port number of 8080, an IP address of 10.10.10.1). Numeric values can be entered as a series of digits without
spaces or commas (for example, 10 or 64400), in dotted decimal format (for example the IP address 10.10.10.1)
or, as in the case of MAC or IPv6 addresses, separated by colons (e.g. the MAC address 00:09:0F:B7:37:00).
Most numeric values are standard base-10 numbers, but some fields - again, such as MAC addresses - require
hexadecimal numbers.

Most GUI numeric value fields make it easy to add the acceptable number of digits within the allowed range. CLI
help text includes information about allowed numeric value ranges. Both the GUI and the CLI prevent you from
entering invalid numbers.
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The command line interface (CLI) is an alternative configuration tool to the GUI or web-based manager. While
the configuration of the GUI uses a point-and-click method, the CLI requires typing commands or uploading
batches of commands from a text file, like a configuration script.

This section explains common CLI tasks that an administrator does on a regular basis and includes the topics:

l Connecting to the CLI
l Command syntax
l Sub-commands
l Permissions
l Tips

Connecting to the CLI
You can access the CLI in three ways:

l Locally with a console cable — Connect your computer directly to the FortiGate unit’s console port. Local access is
required in some cases:
l If you are installing your FortiGate unit for the first time and it is not yet configured to connect to your network,

you may only be able to connect to the CLI using a local serial console connection, unless you reconfigure your
computer’s network settings for a peer connection.

l Restoring the firmware utilizes a boot interrupt. Network access to the CLI is not available until after the boot
process has completed, making local CLI access the only viable option.

l Through the network— Connect your computer through any network attached to one of the FortiGate unit’s
network ports. The network interface must have enabled Telnet or SSH administrative access if you connect using
an SSH/Telnet client, or HTTP/HTTPS administrative access if you connect by accessing the CLI Console in the
GUI. The CLI console can be accessed from the upper-right hand corner of the screen and appears as a slide-out
window.

l Locally with FortiExplorer for iOS— Use the FortiExplorer app on your iOS device to configure, manage, and
monitor your FortiGate.

Connecting to the CLI using a local console

Local console connections to the CLI are formed by directly connecting your management computer or console to
the FortiGate unit, using its DB-9 or RJ-45 console port. To connect to the local console you need:

l A computer with an available serial communications (COM) port.
l The RJ-45-to-DB-9 or null modem cable included in your FortiGate package.
l Terminal emulation software such as HyperTerminal for Microsoft Windows.

The following procedure describes the connection using Microsoft HyperTerminal software; steps may vary with
other terminal emulators.

To connect to the CLI using a local serial console connection

1. Using the null modem or RJ-45-to-DB-9 cable, connect the FortiGate unit’s console port to the serial
communications (COM) port on your management computer.
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2. On your management computer, start HyperTerminal.
3. For the Connection Description, enter a Name for the connection, and select OK.
4. On the Connect using drop-down, select the communications (COM) port on your management computer you

are using to connect to the FortiGate unit.
5. Select OK.
6. Select the following Port settings and select OK.

Bits per second 9600

Data bits 8

Parity None

Stop bits 1

Flow control None

7. PressEnter orReturn on your keyboard to connect to the CLI.
8. Type a valid administrator account name (such as admin) and pressEnter.
9. Type the password for that administrator account and pressEnter. (In its default state, there is no password for

the admin account.)
The CLI displays the following text:

Welcome!
Type ? to list available commands.

You can now enter CLI commands, including configuring access to the CLI through SSH or Telnet.

Enabling access to the CLI through the network (SSH or Telnet)

SSH or Telnet access to the CLI is accomplished by connecting your computer to the FortiGate unit using one of
its RJ-45 network ports. You can either connect directly, using a peer connection between the two, or through any
intermediary network.

If you do not want to use an SSH/Telnet client and you have access to the web-based
manager, you can alternatively access the CLI through the network using the CLI
Consolewidget in the web-based manager.

You must enable SSH and/or Telnet on the network interface associated with that physical network port. If your
computer is not connected directly or through a switch, you must also configure the FortiGate unit with a static
route to a router that can forward packets from the FortiGate unit to your computer. You can do this using either a
local console connection or the web-based manager.

Requirements

l A computer with an available serial communications (COM) port and RJ-45 port
l Terminal emulation software such as HyperTerminal for Microsoft Windows
l The RJ-45-to-DB-9 or null modem cable included in your FortiGate package
l A network cable
l Prior configuration of the operating mode, network interface, and static route.
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To enable SSH or Telnet access to the CLI using a local console connection

1. Using the network cable, connect the FortiGate unit’s network port either directly to your computer’s network port,
or to a network through which your computer can reach the FortiGate unit.

2. Note the number of the physical network port.
3. Using a local console connection, connect and log into the CLI.
4. Enter the following command:

config system interface
edit <interface_str>

set allowaccess <protocols_list>
end

where:

l <interface_str> is the name of the network interface associated with the physical network port and
containing its number, such as port1.

l <protocols_list> is the complete, space-delimited list of permitted administrative access protocols, such
as https ssh telnet.

For example, to exclude HTTP, HTTPS, SNMP, and PING, and allow only SSH and Telnet administrative
access on port1, enter the following:

config system interface
edit port1

set allowaccess ssh telnet
end

5. To confirm the configuration, enter the command to display the network interface’s settings.
show system interface <interface_str>

The CLI displays the settings, including the allowed administrative access protocols, for the network
interfaces.

Connecting to the CLI using SSH

Once the FortiGate unit is configured to accept SSH connections, you can use an SSH client on your
management computer to connect to the CLI.

Secure Shell (SSH) provides both secure authentication and secure communications to the CLI. FortiGate units
support 3DES and Blowfish encryption algorithms for SSH.

Before you can connect to the CLI using SSH, you must first configure a network interface to accept SSH
connections. The following procedure uses PuTTY. Steps may vary with other SSH clients.

To connect to the CLI using SSH

1. On your management computer, start an SSH client.
2. In Host Name (or IP address), enter the IP address of a network interface on which you have enabled SSH

administrative access.
3. Set a Port of 22.
4. For the Connection type, select SSH.
5. Select Open.

The SSH client connects to the FortiGate unit.
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The SSH client may display a warning if this is the first time you are connecting to the FortiGate unit
and its SSH key is not yet recognized by your SSH client, or if you have previously connected to the
FortiGate unit but used a different IP address or SSH key. This is normal if your management
computer is directly connected to the FortiGate unit with no network hosts between them.

6. ClickYes to verify the fingerprint and accept the FortiGate unit’s SSH key. You will not be able to log in until you
have accepted the key.

7. The CLI displays a login prompt.
8. Type a valid administrator account name (such as admin) and pressEnter.
9. Type the password for this administrator account and pressEnter.

The FortiGate unit displays a command prompt (its hostname followed by a #). You can now enter
CLI commands.

If three incorrect login or password attempts occur in a row, you will be disconnected.
If this occurs, wait one minute, then reconnect to attempt the login again.

Connecting to the CLI using Telnet

Once the FortiGate unit is configured to accept Telnet connections, you can use a Telnet client on your
management computer to connect to the CLI.

Telnet is not a secure access method. SSH should be used to access the CLI from the
Internet or any other untrusted network.

Before you can connect to the CLI using Telnet, you must first configure a network interface to accept Telnet
connections.

To connect to the CLI using Telnet

1. On your management computer, start a Telnet client.
2. Connect to a FortiGate network interface on which you have enabled Telnet.
3. Type a valid administrator account name (such as admin) and pressEnter.
4. Type the password for this administrator account and pressEnter.

The FortiGate unit displays a command prompt (its hostname followed by a #). You can now enter
CLI commands.

If three incorrect login or password attempts occur in a row, you will be disconnected.
If this occurs, wait one minute, then reconnect to attempt the login again.
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As you can see in the Feature / Platform Matrix, the entry level models have a number of features that are only
available using the CLI, rather than appearing in the GUI.

You can open the CLI console so that it automatically opens to the object you wish to configure. For example, to
edit a firewall policy, right-click on the policy in the policy list (Policy & Objects > IPv4 Policy) and select Edit
in CLI. The CLI console will appear, with the commands to access this part of the configuration added
automatically.

Once you have access to the CLI, you can enter instructions for specific tasks that can be found throughout the
FortiOS Handbook. Options are also available at the top of the CLI Console to Clear console, Download, and
Copy to clipboard.

Refer to the CLI Reference for a list of the available commands.
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Command syntax
When entering a command, the CLI console requires that you use valid syntax and conform to expected input
constraints. It will reject invalid commands.

Fortinet documentation uses the conventions below to describe valid command syntax.

Terminology

Each command line consists of a command word that is usually followed by configuration data or other specific
item that the command uses or affects.

To describe the function of each word in the command line, especially if that nature has changed between
firmware versions, Fortinet uses terms with the following definitions.

Command syntax terminology

l Command— Aword that begins the command line and indicates an action that the FortiGate unit should perform
on a part of the configuration or host on the network, such as config or execute. Together with other words,
such as fields or values, that end when you press the Enter key, it forms a command line. Exceptions include multi-
line command lines, which can be entered using an escape sequence.
Valid command lines must be unambiguous if abbreviated. Optional words or other command line permutations are
indicated by syntax notation.

l Sub-command— A kind of command that is available only when nested within the scope of another command.
After entering a command, its applicable sub-commands are available to you until you exit the scope of the
command, or until you descend an additional level into another sub-command. Indentation is used to indicate levels
of nested commands.
Not all top-level commands have sub-commands. Available sub-commands vary by their containing scope.

l Object— Apart of the configuration that contains tables and /or fields. Valid command lines must be specific
enough to indicate an individual object.

l Table— A set of fields that is one of possibly multiple similar sets which each have a name or number, such as an
administrator account, policy, or network interface. These named or numbered sets are sometimes referenced by
other parts of the configuration that use them.

l Field— The name of a setting, such as ip or hostname. Fields in some tables must be configured with values.
Failure to configure a required field will result in an invalid object configuration error message, and the FortiGate
unit will discard the invalid table.
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l Value— Anumber, letter, IP address, or other type of input that is usually your configuration setting held by a field.
Some commands, however, require multiple input values which may not be named but are simply entered in
sequential order in the same command line. Valid input types are indicated by constraint notation.

l Option— A kind of value that must be one or more words from of a fixed set of options.

Indentation

Indentation indicates levels of nested commands, which indicate what other sub-commands are available from
within the scope. For example, the edit sub-command is available only within a command that affects tables,
and the next sub-command is available only from within the edit sub-command:

config system interface
edit port1

set status up
next

end

Notation

Brackets, braces, and pipes are used to denote valid permutations of the syntax. Constraint notations, such as
<address_ipv4>, indicate which data types or string patterns are acceptable value input.

Command syntax notation

Convention Description

Square brackets [ ] An optional word or series of words. For example:

[verbose {1 | 2 | 3}]

indicates that you may either omit or type both the verbose word and its
accompanying option, such as verbose 3.

Curly braces { } Aword or series of words that is constrained to a set of options delimited by
either vertical bars or spaces. You must enter at least one of the options,
unless the set of options is surrounded by square brackets [ ].

Options delimited by
vertical bars |

Mutually exclusive options. For example:

{enable | disable}

indicates that you must enter either enable or disable, but must not
enter both.
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Convention Description

Angle brackets < > Aword constrained by data type. The angled brackets contain a
descriptive name followed by an underscore ( _ ) and suffix that indicates
the valid data type. For example, <retries_int>, indicates that you
should enter a number of retries as an integer.

Data types include:

l <xxx_name>: A name referring to another part of the configuration,
such as policy_A.

l <xxx_index>: An index number referring to another part of the
configuration, such as 0 for the first static route.

l <xxx_pattern>: A regular expression or word with wild cards that
matches possible variations, such as *@example.com to match all
email addresses ending in @example.com.

l <xxx_fqdn>: A fully qualified domain name (FQDN), such as
mail.example.com.

l <xxx_email>: An email address, such as admin@example.com.
l <xxx_ipv4>: An IPv4 address, such as 192.168.1.99.
l <xxx_v4mask>: A dotted decimal IPv4 netmask, such as
255.255.255.0.

l <xxx_ipv4mask>: A dotted decimal IPv4 address and netmask
separated by a space, such as 192.168.1.99 255.255.255.0.

l <xxx_ipv4/mask>: A dotted decimal IPv4 address and CIDR-notation
netmask separated by a slash, such as 192.168.1.1/24

l <xxx_ipv4range>  : A hyphen ( - )-delimited inclusive range of IPv4
addresses, such as 192.168.1.1-192.168.1.255.

l <xxx_ipv6>: A colon( : )-delimited hexadecimal IPv6 address, such as
3f2e:6a8b:78a3:0d82:1725:6a2f:0370:6234.

l <xxx_v6mask>: An IPv6 netmask, such as /96.
l <xxx_ipv6mask>: A dotted decimal IPv6 address and netmask
separated by a space.

l <xxx_str>: A string of characters that is not another data type, such as
P@ssw0rd. Strings containing spaces or special characters must be
surrounded in quotes or use escape sequences.

l <xxx_int>: An integer number that is not another data type, such as
15 for the number of minutes.

Options delimited by
spaces

Non-mutually exclusive options. For example:

{http https ping snmp ssh telnet}

indicates that you may enter all or a subset of those options, in any order,
in a space-delimited list, such as:

ping https ssh
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Sub-commands
Each command line consists of a command word that is usually followed by configuration data or other specific
item that the command uses or affects:

get system admin

Sub-commands are available from within the scope of some commands. When you enter a sub-command level,
the command prompt changes to indicate the name of the current command scope. For example, after entering:

config system admin

the command prompt becomes:

(admin)#

Applicable sub-commands are available to you until you exit the scope of the command, or until you descend an
additional level into another sub-command.

For example, the edit sub-command is available only within a command that affects tables; the next sub-
command is available only from within the edit sub-command:

config system interface
edit port1

set status up
next

end

Sub-command scope is indicated by indentation.

Available sub-commands vary by command. From a command prompt within config, two types of sub-
commands might become available:

l commands affecting fields
l commands affecting tables

Commands for tables

clone <table> Clone (or make a copy of) a table from the current object.

For example, in config firewall policy, you could enter the
following command to clone security policy 27 to create security policy 30:

clone 27 to 30

In config antivirus profile, you could enter the following
command to clone an antivirus profile named av_pro_1 to create a new
antivirus profile named av_pro_2:

clone av_pro_1 to av_pro_2

clone may not be available for all tables.
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delete <table> Remove a table from the current object.

For example, in config system admin, you could delete an
administrator account named newadmin by typing delete newadmin
and pressing Enter. This deletes newadmin and all its fields, such as
newadmin’s first-name and email-address.

delete is only available within objects containing tables.

edit <table> Create or edit a table in the current object.

For example, in config system admin:

•   edit the settings for the default admin administrator account by typing
edit admin.
•   add a new administrator account with the name newadmin and edit
newadmin‘s settings by typing edit newadmin.

edit is an interactive sub-command: further sub-commands are available
from within edit.

edit changes the prompt to reflect the table you are currently editing.

edit is only available within objects containing tables.

In objects such as security policies, <table> is a sequence number. To
create a new entry without the risk of overwriting an existing one, enter
edit 0. The CLI initially confirms the creation of entry 0, but assigns the
next unused number after you finish editing and enter end.

end Save the changes to the current object and exit the config command.
This returns you to the top-level command prompt.

get List the configuration of the current object or table.

•   In objects, get lists the table names (if present), or fields and their
values.
•   In a table, get lists the fields and their values.
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purge

Remove all tables in the current object.

For example, in config user local, you could type get to see the list
of user names, then type purge and then y to confirm that you want to
delete all users.

purge is only available for objects containing tables.

Caution: Back up the FortiGate before performing a purge. purge
cannot be undone. To restore purged tables, the configuration must be
restored from a backup.

Caution: Do not purge system interface or system admin tables.
purge does not provide default tables. This can result in being unable to
connect or log in, requiring the FortiGate unit to be formatted and restored.

rename <table> to <table> Rename a table.

For example, in config system admin, you could rename admin3 to
fwadmin by typing rename admin3 to fwadmin.

rename is only available within objects containing tables.

show Display changes to the default configuration. Changes are listed in the
form of configuration commands.

Example of table commands

From within the system admin object, you might enter:

edit admin_1

The CLI acknowledges the new table, and changes the command prompt to show that you are now within the
admin_1 table:

new entry 'admin_1' added
(admin_1)#

Commands for fields

abort Exit both the edit and/or config commands without saving the fields.

append Add an option to an existing list.

end Save the changes made to the current table or object fields, and exit the config
command (to exit without saving, use abort instead).

get

List the configuration of the current object or table.

•   In objects, get lists the table names (if present), or fields and their values.
•   In a table, get lists the fields and their values.
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move Move an object within a list, when list order is important. For example, rearranging
security policies within the policy list.

next

Save the changes you have made in the current table’s fields, and exit the edit
command to the object prompt (to save and exit completely to the root prompt, use
end instead).

next is useful when you want to create or edit several tables in the same object,
without leaving and re-entering the config command each time.

next is only available from a table prompt; it is not available from an object prompt.

select Clear all options except for those specified.

For example, if a group contains members A, B, C, and D and you remove all users
except for B, use the command select member B.

set <field>
<value>

Set a field’s value.

For example, in config system admin, after typing edit admin, you could
type set password newpass to change the password of the admin administrator
to newpass.

Note:When using set to change a field containing a space-delimited list, type the
whole new list. For example, set <field> <new-value> will replace the list with
the <new-value> rather than appending <new-value> to the list.

show Display changes to the default configuration. Changes are listed in the form of
configuration commands.

unselect Remove an option from an existing list.

unset <field> Reset the table or object’s fields to default values.

For example, in config system admin, after typing edit admin, typing unset
password resets the password of the admin administrator account to the default (in
this case, no password).

Example of field commands

From within the admin_1 table, you might enter:

set password my1stExamplePassword

to assign the value my1stExamplePassword to the password field. You might then enter the next
command to save the changes and edit the next administrator’s table.
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Permissions
Access profiles control which CLI commands an administrator account can access. Access profiles assign either
read, write, or no access to each area of FortiOS. To view configurations, you must have read access. To make
changes, you must have write access. So, depending on the account used to log in to the FortiGate, you may not
have complete access to all CLI commands. For complete access to all commands, you must log in with an
administrator account that has the super_admin access profile. By default the admin administrator account
has the super_admin access profile.

Administrator accounts, with the super_admin access profile are similar to a root administrator account that
always has full permission to view and change all FortiGate configuration options, including viewing and changing
all other administrator accounts and including changing other administrator account passwords.

Increasing the security of administrator accounts

Set strong passwords for all administrator accounts (including the admin account) and change passwords
regularly.

For more information about increasing the security of administrator accounts, see:

l Hardening your FortiGate
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Tips
Basic features and characteristics of the CLI environment provide support and ease of use for many CLI tasks.

Help

To display brief help during command entry, press the question mark (?) key.

l Press the question mark (?) key at the command prompt to display a list of the commands available and a
description of each command.

l Type a word or part of a word, then press the question mark (?) key to display a list of valid word completions or
subsequent words, and to display a description of each.

Shortcuts and key commands

Keys Action

? List valid word completions or subsequent words.

If multiple words could complete your entry, display all possible completions with
helpful descriptions of each.

Tab Complete the word with the next available match.

Press the Tab key multiple times to cycle through available matches.

Up arrow, or
Ctrl + P

Recall the previous command.

Command memory is limited to the current session.

Down arrow, or
Ctrl + N

Recall the next command.

Left or Right
arrow

Move the cursor left or right within the command line.

Ctrl + A Move the cursor to the beginning of the command line.

Ctrl + E Move the cursor to the end of the command line.

Ctrl + B Move the cursor backwards one word.

Ctrl + F Move the cursor forwards one word.

Ctrl + D Delete the current character.
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Keys Action

Ctrl + C Abort current interactive commands, such as when entering multiple lines.

If you are not currently within an interactive command such as config or edit, this
closes the CLI connection.

\ then Enter Continue typing a command on the next line for a multi-line command.

For each line that you want to continue, terminate it with a backslash ( \ ). To complete
the command line, terminate it by pressing the spacebar and then the Enter key,
without an immediately preceding backslash.

Command abbreviation

You can abbreviate words in the command line to their smallest number of non-ambiguous characters.

For example, the command get system status could be abbreviated to g sy stat.

Adding and removing options from lists

When adding options to a list, such as a user group, using the set command will remove the previous
configuration. For example, if you wish to add user D to a user group that already contains members A, B, and C,
the command would need to be set member A B C D. If only set member D was used, then all former
members would be removed from the group.

However, there are additional commands which can be used instead of set for changing options in a list.

Additional commands for lists

append Add an option to an existing list.

For example, append member would add user D to a user group while all previous
group members are retained

select Clear all options except for those specified.

For example, if a group contains members A, B, C, and D and you remove all users
except for B, use the command select member B.

unselect Remove an option from an existing list.

For example, unselect member A would remove member A from a group will all
previous group members are retained.

Environment variables

The CLI supports the following environment variables. Variable names are case-sensitive.
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Environment variables

$USERFROM The management access type (ssh, telnet, jsconsole for the CLI Console
widget in the web-based manager, and so on) and the IP address of the administrator
that configured the item.

$USERNAME The account name of the administrator that configured the item.

$SerialNum The serial number of the FortiGate unit.

For example, the FortiGate unit’s host name can be set to its serial number:

config system global
set hostname $SerialNum

end

Special characters

The following special characters, also known as reserved characters, are not permitted in most CLI fields:

< > ( ) # ' “

You may be able to enter special characters as part of a string’s value by using a special command, enclosing it in
quotes, or preceding it with an escape sequence — in this case, a backslash ( \ ) character.

In other cases, different keystrokes are required to input a special character. If you need to enter ? as part of
config, you first need to input CTRL-V. If you enter ? without first using CTRL-V, the question mark has a
different meaning in the CLI; it will show available command options in that section.

For example, if you enter ? without CTRL-V:
edit "*.xe
token line: Unmatched double quote.

If you enter ? with CTRL-V:
edit "*.xe?"
new entry '*.xe?' added

Entering special characters

Character Keys

? Ctrl + V then ?

Tab Ctrl + V then Tab
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Character Keys

Space

(to be interpreted as part of a string value,
not to end the string)

Enclose the string in quotation marks: "Security
Administrator”.

Enclose the string in single quotes: 'Security
Administrator'.

Precede the space with a backslash: Security\
Administrator.

'

(to be interpreted as part of a string value,
not to end the string)

\'

"

(to be interpreted as part of a string value,
not to end the string)

\"

\ \\

Using grep to filter get and show command output

In many cases, the get and show (and diagnose) commands may produce a large amount of output. If you
are looking for specific information in a large get or show command output, you can use the grep command to
filter the output to only display what you are looking for. The grep command is based on the standard UNIX
grep, used for searching text output based on regular expressions.

Use the following command to display the MAC address of the FortiGate unit internal interface:

get hardware nic internal | grep Current_HWaddr
Current_HWaddr 00:09:0f:cb:c2:75

Use the following command to display all TCP sessions in the session list and include the session list line number
in the output:

get system session list | grep -n tcp

Use the following command to display all lines in HTTP replacement message commands that contain URL
(upper or lower case):

show system replacemsg http | grep -i url

There are three additional options that can be applied to grep:

-A <num> After
-B <num> Before
-C <num> Context

The option -f is also available to support contextual output, in order to show the complete configuration. The
following example shows the difference in output when -f option is used versus when it is not.
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Using -f:

show | grep -f ldap-group1
config user group

edit "ldap-group1"
set member "pc40-LDAP"

next
end
config firewall policy

edit 2
set srcintf "port31"
set dstintf "port32"
set srcaddr "all"
set action accept
set identity-based enable
set nat enable
config identity-based-policy

edit 1
set schedule "always"
set groups "ldap-group1"
set dstaddr "all"
set service "ALL"

next
end

next
end

Without using -f:

show | grep ldap-group1
edit "ldap-group1"

set groups "ldap-group1"

Language support and regular expressions

Characters such as ñ, é, symbols, and ideographs are sometimes acceptable input. Support varies by the nature
of the item being configured. CLI commands, objects, field names, and options must use their exact ASCII
characters, but some items with arbitrary names or values may be input using your language of choice. To use
other languages in those cases, you must use the correct encoding.

Input is stored using Unicode UTF-8 encoding but is not normalized from other encodings into UTF-8 before it is
stored. If your input method encodes some characters differently than in UTF-8, your configured itemsmay not
display or operate as expected.

Regular expressions are especially impacted. Matching uses the UTF-8 character values. If you enter a regular
expression using another encoding, or if an HTTP client sends a request in an encoding other than UTF-8,
matches may not be what you expect.

For example, with Shift-JIS, backslashes ( \ ) could be inadvertently interpreted as the symbol for the Japanese
yen ( ¥ ) and vice versa. A regular expression intended to match HTTP requests containing money values with a
yen symbol therefore may not work it if the symbol is entered using the wrong encoding.

For best results, you should:
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l use UTF-8 encoding, or
l use only the characters whose numerically encoded values are the same in UTF-8, such as the US-ASCII characters

that are also encoded using the same values in ISO 8859-1, Windows code page 1252, Shift-JIS and other
encodings, or

l for regular expressions that must match HTTP requests, use the same encoding as your HTTP clients.

HTTP clients may send requests in encodings other than UTF-8. Encodings usually
vary by the client’s operating system or input language. If you cannot predict the
client’s encoding, you may only be able to match any parts of the request that are in
English, because regardless of the encoding, the values for English characters tend to
be encoded identically. For example, English words may be legible regardless of
interpreting a web page as either ISO 8859-1 or as GB2312, whereas simplified
Chinese characters might only be legible if the page is interpreted as GB2312.

If you configure your FortiGate unit using other encodings, you may need to switch language settings on your
management computer, including for your web browser or Telnet/SSH client. For instructions on how to configure
your management computer’s operating system language, locale, or input method, see its documentation.

If you choose to configure parts of the FortiGate unit using non-ASCII characters, verify that all systems
interacting with the FortiGate unit also support the same encodings. You should also use the same encoding
throughout the configuration if possible in order to avoid needing to switch the language settings of the web-
based manager and your web browser or Telnet/SSH client while you work.

Similarly to input, your web browser or CLI client should normally interpret display output as encoded using UTF-
8. If it does not, your configured itemsmay not display correctly in the GUI or CLI. Exceptions include items such
as regular expressions that you may have configured using other encodings in order to match the encoding of
HTTP requests that the FortiGate unit receives.

To enter non-ASCII characters in the CLI Console:

1. On your management computer, start your web browser and go to the URL for the FortiGate unit’s GUI.
2. Configure your web browser to interpret the page as UTF-8 encoded.
3. Log in to the FortiGate unit.
4. Open the CLI Console from the upper right-hand corner.
5. In the title bar of the CLI Consolewidget, clickEdit (the pencil icon).
6. Enable Use external command input box and select OK.
7. The Command field appears below the usual input and display area of the CLI Console .
8. Type a command in this field and pressEnter.

In the display area, the CLI Consolewidget displays your previous command interpreted into its character
code equivalent, such as:

edit \743\601\613\743\601\652

and the command’s output.

To enter non-ASCII characters in a Telnet/SSH client

1. On your management computer, start your Telnet or SSH client.
2. Configure your Telnet or SSH client to send and receive characters using UTF-8 encoding.

Support for sending and receiving international characters varies by each Telnet/SSH client. Consult the
documentation for your Telnet/SSH client.
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3. Log in to the FortiGate unit.
4. At the command prompt, type your command and pressEnter.

You may need to surround words that use encoded characters with single quotes ( ' ).

Depending on your Telnet/SSH client’s support for your language’s input methods and for sending
international characters, you may need to interpret them into character codes before pressing Enter.

For example, you might need to enter:

edit '\743\601\613\743\601\652'

5. The CLI displays your previous command and its output.

Screen paging

You can configure the CLI to pause after displaying each page’s worth of text when displaying multiple pages of
output. When the display pauses, the last line displays --More--. You can then either:

l press the spacebar to display the next page.
l type Q to truncate the output and return to the command prompt.

This may be useful when displaying lengthy output, such as the list of possible matching commands for
command completion, or a long list of settings. Rather than scrolling through or possibly exceeding the buffer of
your terminal emulator, you can simply display one page at a time.

To configure the CLI Console to pause display when the screen is full:

config system console
set output more

end

Baud rate

You can change the default baud rate of the local console connection.

To change the baud rate enter the following commands:

config system console
set baudrate {9600 | 19200 | 38400 | 57600 | 115200}

end

Editing the configuration file on an external host

You can edit the FortiGate configuration on an external host by first backing up the configuration file to a TFTP
server. Then edit the configuration file and restore it to the FortiGate unit.

Editing the configuration on an external host can be timesaving if you have many changes to make, especially if
your plain text editor provides advanced features such as batch changes.

To edit the configuration on your computer:

1. Use execute backup to download the configuration file to a TFTP server, such as your management
computer.

2. Edit the configuration file using a plain text editor that supports Unix-style line endings.
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Do not edit the first line. The first line(s) of the configuration file (preceded by a #
character) contains information about the firmware version and FortiGate model. If
you change the model number, the FortiGate unit will reject the configuration file
when you attempt to restore it.

3. Use execute restore to upload the modified configuration file back to the FortiGate unit.
The FortiGate unit downloads the configuration file and checks that the model information is correct. If it is
correct, the FortiGate unit loads the configuration file and checks each command for errors. If a command is
invalid, the FortiGate unit ignores the command. If the configuration file is valid, the FortiGate unit restarts
and loads the new configuration.
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FortiExplorer for iOS is a user-friendly application that helps you to quickly and easily configure, manage, and
monitor FortiGate appliances using an iOS device. FortiExplorer lets you rapidly provision, deploy, and monitor
Security Fabric components including FortiGate, FortiWiFi, and FortiAP devices.

FortiExplorer for iOS requires iOS 9.3 or later and is compatible with iPhone, iPad, and iPod Touch. It is
supported by FortiOS 5.6+ and is only available on the App Store for iOS devices.

Advanced features are available with the purchase of FortiExplorer Pro. Paid features include the ability to add
more than two devices and the ability to download firmware images from FortiCare.

Up to six members can use this app with 'Family Sharing' enabled in the App Store.

Getting started with FortiExplorer
If your FortiGate is accessible on the wireless network, you can connect to it using FortiExplorer provided that
your iOS device is on the same network (see Connecting FortiExplorer to a FortiGate via WiFi). Otherwise, you
will need to physically connect your iOS device to the FortiGate using a USB cable (see below).

Connecting FortiExplorer to a FortiGate via USB

For the purpose of this document, we assume that you are just getting started; you do not have access to the
FortiGate over the wireless network, and the FortiGate is in its factory configuration.

1. Connect your iOS device to your FortiGate’s USBmanagement port.
If prompted on your iOS device, Trust this 'computer'.

2. Open the FortiExplorer app and select your FortiGate from the list underUSB Attached Device.
3. On the Login screen, select USB.
4. Enter the default Username (admin) and leave the Password field blank.
5. You can opt to Remember Password. Tap Donewhen you are ready.

FortiExplorer opens the FortiGate management interface to the Device Status page:
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6. Go to Network > Interfaces and configure the WAN interface(s).
In the example, thewan1 interface Addressmode is set to DHCP by default. Set it toManual and enter its
Address, Netmask, and Default Gateway, and then Apply your changes.

7. (Optional) Configure Administrative Access to allowHTTP and HTTPS access.
This will allow administrators to access the FortiGate web-based manager using a web browser.
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8. Go to Network > Interfaces and configure the local network (internal) interface.
Set the Addressmode as before and configure Administrative Access if desired.

9. Configure a DHCP Server for the internal network subnet.

Return to the internal interface using the< button at the top of the screen.

10. Go to Network > Static Routes and configure the static route to the gateway.
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11. Go to Policy & Objects > Policy and edit the Internet access policy. As a best practice, provide a Name for the
policy, enable the desired Security Profiles, and configure Logging Options. Select OK to finalize.

Running a Security Fabric Audit

The FortiGate is now configured in a very basic state. Once you've configured the other potential elements of
your network, such as other Interfaces, Schedules, orManaged FortiAPs, it is recommended that you run a
Security Fabric Audit to identify potential vulnerabilities and highlight best practices that could be used to
improve your network’s overall security and performance.

Follow the steps of the Security Fabric Audit (under Security Fabric > Audit) to determine a Security Score
for the selected device(s). The results should identify issues ranging from Medium to Critical importance, and
may provide recommended actions where possible.
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Connecting FortiExplorer to a FortiGate via WiFi

If your FortiGate is accessible on the wireless network, you can connect to it using FortiExplorer provided that
your iOS device is on the same network. Assuming this is the case:

1. Open the FortiExplorer app and select Add from the Devices page.
2. Enter the Host information and appropriate Username and Password credentials. If necessary, change the

default Port number, and opt to Remember Password.

3. If the FortiGate device identity cannot be verified, clickConnect at the prompt.
FortiExplorer opens the FortiGate management interface to the Device Status page.

Upgrading to FortiExplorer Pro

Paid features provided with the purchase of FortiExplorer Pro include the ability to add more than two devices and
the ability to download firmware images from FortiCare.

l To upgrade to FortiExplorer Pro, open the FortiExplorer app, go to Settings and select Upgrade to FortiExplorer
Pro. Follow the on-screen prompts.
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The following section includes information regarding FortiGate LED status indicators.

l Sample FortiGate faceplates
l LED status codes
l About alarm levels
l LED status codes for ports

Sample FortiGate faceplates
The faceplates indicate where the LEDs are typically found on desktop and mid-range FortiGate models.

FortiGate 60C

FortiGate 100D
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FortiGate 30E

LED status codes

LABEL STATE MEANING

PWR Green

Off

Power is On.

Power is Off.

STA Green

Flashing Green

Red

Normal status.

Booting Up. If the FortiGate has a reset button, Flashing Green also
means that the reset button was used.

The FortiGate has a critical alarm (see About Alarm Levels).

ALARM Off

Amber

Red

No alarms or the FortiGate has a minor alarm.

The FortiGate has a major alarm.

The FortiGate has a critical alarm.
The status LED will also be red.

More information at About Alarm Levels.

HA Green

Red

Off

The FortiGate is operating in an FGCPHA cluster.

A failover has occurred. This usually means that one of the FotiGates
in an HA cluster has failed or that HA heartbeat communication
between the FortiGates in the HA cluster has failed or been
interrupted.

HA not configured.

Failover operation feature not available in all units.
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LABEL STATE MEANING

WIFI Green

Flashing Green

Off

Wireless port is active.

Wireless interface is transmitting and receiving data.

Wireless interface is down.

About alarm levels
Minor, major, and critical alarms are defined based on IPMI, ATCA, and Telco standards for naming alarms.

l Aminor alarm (also called an IPMI non-critical (NC) alarm) indicates a temperature or a power level outside of the
normal operating range that is not considered a problem. In the case of a minor temperature alarm, the system
could respond by increasing fan speed. A non-critical threshold can be an upper non-critical (UNC) threshold (for
example, a high temperature or a high power level) or a lower non-critical (LNC) threshold (for example, a low power
level). The LEDs do not indicate minor alarms since user intervention is not required.

l Amajor alarm (also called an IPMI critical or critical recoverable (CR) alarm) indicates that the system itself cannot
correct the cause for the alarm and that intervention is required. For example, the cooling system cannot provide
enough cooling to reduce the temperature. It could also mean that conditions (e.g. temperature) are approaching
the outside limit of the allowed operating range. A critical threshold can also be an upper critical (UC) threshold (e.g.
a high temperature or a high power level) or a lower critical (LC) threshold (e.g. a low power level).

l A critical alarm (also called an IPMI non-recoverable (NR) alarm) indicates detection of a temperature or power level
that is outside of the allowed operating range and could potentially cause physical damage.

LED status codes for ports

TYPE OF PORT STATE MEANING

Ethernet Ports
Link / Activity

Green

Flashing Green

Off

Connected.

Transmitting and receiving data.

No link established.

On FortiGate models with front-facing ports, this LED is to the
left of the port. On FortiGate models with ports at the back of
the device, this LED is in the upper row.

SFP Ports Green

Flashing Green

Off

Connected.

Transmitting and receiving data.

No link established.
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TYPE OF PORT STATE MEANING

Ethernet Ports
Speed

Green

Amber

Off

Connected at 1Gbps.

Connected at 100Mbps.

Not connected or connected at 10Mbps.

On FortiGate models with front-facing ports, this LED is to the
right of the port. On FortiGate models with ports at the back of
the device, this LED is in the lower row.
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To control your FortiGate's security profile inspection mode in FortiOS 5.6, you can select Flow-based or Proxy
inspection modes from System > Settings. Having control over flow and proxy mode is helpful if you want to
ensure that only flow inspection mode is used.

In most cases proxy mode is preferred because more security profile features are available along with more
configuration options for these individual features. Some implementations, however, may require all security
profile scanning to only use flow mode. In this case, you can set your FortiGate to flow mode knowing that proxy
mode inspection will not be used.

Setting up the FortiGate to operate in these new modes (or to operate in the other available operating
modes) involves going to System > Settings and changing the Inspection Mode and NGFW Mode.

NGFWmode simplifies applying application control and web filtering to traffic by allowing you to add applications
and web filtering profiles directly to policies.

Transparent proxy allows you to apply web authentication to HTTP traffic without using the explicit proxy.

Changing inspection and policy modes

To change inspection modes, go to System > Settings. You can select Flow-based to operate in flow mode or
Proxy to operate in proxy mode.

NGFW policy mode

When you select Flow-based as the Inspection Mode, you have the option to select an NGFW Mode. Profile-
basedmode works the same as flow-based mode did in FortiOS 5.4.

In Policy-basedmode, you add applications and web filtering profiles directly to a policy without having to first
create and configure Application Control or Web Filtering profiles.

When you change to Flow-based inspection, all proxy mode profiles are converted to flow mode, removing any
proxy settings. In addition, proxy-mode only features (for example, Web Application Profile) are removed from the
GUI.

If your FortiGate has multiple VDOMs, you can set the inspection mode independently for each VDOM. Go to
System > VDOM. ClickEdit for the VDOM you wish to change and select the Inspection Mode.

CLI syntax

The following CLI command can be used to configure inspection and policy modes:

config system settings
set inspection-mode {proxy | flow}
set policy-mode {standard | ngfw}

end

Security profile features mapped to inspection mode

The table below lists FortiOS security profile features and shows whether they are available in flow-based or
proxy-based inspection modes.
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Security Profile Feature Flow-based inspection Proxy-based inspection

AntiVirus x x

Web Filter x x

DNS Filter x x

Application Control x x

Intrusion Protection x x

Anti-Spam x

Data Leak Protection x

VoIP x

ICAP x

Web Application Firewall x

FortiClient Profiles x x

Proxy Options x x

SSL Inspection x x

SSH Inspection x

Web Rating Overrides x x

Web Profile Overrides x

From the GUI, you can only configure antivirus and web filter security profiles in proxy mode. From the CLI, you
can configure flow-based antivirus profiles, web filter profiles, and DLP profiles and they will appear on the GUI
and include their inspection mode setting. Flow-based profiles created when in flow mode are still available when
you switch to proxy mode.

In flow mode, antivirus and web filter profiles only include flow-mode features. Web filtering and virus scanning is
still done with the same engines and to the same accuracy, but some inspection options are limited or not
available in flow mode. Application control, intrusion protection, and FortiClient profiles are not affected when
switching between flow and proxy mode.

Even though VoIP profiles are not available from the GUI in flow mode, the FortiGate can process VoIP traffic. In
this case the appropriate session helper is used (for example, the SIP session helper).

Setting flow or proxy mode doesn't change the settings available from the CLI. However, when in flow mode you
can't save security profiles that are set to proxy mode.
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You can also add proxy-only security profiles to firewall policies from the CLI. So, for example, you can add a
VoIP profile to a security policy that accepts VoIP traffic. This practice isn't recommended because the setting will
not be visible from the GUI.

Proxy mode and flow mode antivirus and web filter profile options

The following tables list the antivirus and web filter profile options available in proxy and flow modes.

Antivirus features in proxy and flow mode

Feature Proxy Flow

Scan Mode (Quick or Full) x

Detect viruses (Block or Monitor) x x

Inspected protocols x (all relevant protocols are inspected)

Inspection Options x x

(not available for quick scan mode)

Treat Windows Executables in Email Attachments as
Viruses

x x

Send Files to FortiSandbox Appliance for Inspection x x

Use FortiSandbox Database x x

Include Mobile Malware Protection x x

Web Filter features in proxy and flow mode

Feature Proxy Flow

FortiGuard category based filter x x

(show, allow, monitor,
block)

Category Usage Quota x

Allow users to override blocked categories (on some models) x

Search Engines x
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Feature Proxy Flow

Enforce 'Safe Search' on Google, Yahoo!,
Bing, Yandex

x

Restrict YouTube Access x

Log all search keywords x

Static URL Filter x x

Block invalid URLs x

URL Filter x x

Block malicious URLs discovered by
FortiSandbox

x x

Web Content Filter x x

Rating Options x x

Allow websites when a rating error occurs x x

Rate URLs by domain and IP Address x x

Block HTTP redirects by rating x

Rate images by URL x

Proxy Options x

Restrict Google account usage to specific
domains

x

Provide details for blocked HTTP 4xx and 5xx
errors x

HTTP POST Action x

Remove Java Applets x

Remove ActiveX x

Remove Cookies x

Filter Per-User Black/White List x
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This section contains information about basic FortiGate administration that can be done after you have installed
the unit in your network.

While this section mainly focuses on accomplishing tasks with the GUI, some tasks include instructions to use the
CLI. You can access the CLI using the GUI or FortiExplorer, or via SSH or Telnet connection. For more
information about the CLI, see Using the CLI.

Registration
In order to have full access to Fortinet Support and FortiGuard Services, you must register your FortiGate.

Registering your FortiGate:

1. Go to the Dashboard and locate the Licenseswidget.
2. Click on FortiCare Support to display a pop-up window and Register.
3. In the pop-up window, either use an existing Fortinet Support account or create a new one. Select yourCountry

and Reseller.
4. Select OK.

FortiGate platforms do not impose any limitations on the number or type of customers, users, devices, IP
addresses, or number of VPN clients being served by the platform. Such factors are limited solely by the hardware
capacity of each given model.

System Settings
There are several system settings that should be configured once your FortiGate is installed:

l Default administrator password
l Settings

l Changing the host name
l Central Management
l System Time
l Administration Settings
l Password Policy
l View Settings

l Administrator password retries and lockout time

Default administrator password

By default, your FortiGate has an administrator account set up with the username admin and no password. In
order to prevent unauthorized access to the FortiGate, it is highly recommended that you add a password to this
account.
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To change the default password:

1. Go to System > Administrators.
2. Edit the admin account.
3. Select Change Password.
4. Enter the New Password and re-enter the password for confirmation.
5. Select OK.

For details on selecting a password and password best practices, see the section on Passwords.

It is also recommended to change the user name of this account; however, since you cannot change the user
name of an account that is currently in use, a second administrator account will need to be created in order to do
this. For more information about creating and using administrator accounts, see the Administrators section of the
System Administration chapter.

Settings

Settings can be accessed by going to System > Settings. On this page, you can change the Host name,
designate the centralized security management for your FortiGate in Central Management, set the system time
and identify time zone in System Time, configure HTTP, HTTPS, SSH, and Telnet ports as well as idle timeout
in Administration Settings, designate the Password Policy, and manage display options and designate
inspection mode in View Settings.

Changing the host name

The host name of your FortiGate appears in the Hostname row in the System Information widget on the
Dashboard. The host name also appears at the CLI prompt when you are logged in to the CLI, and as the SNMP
system name.

To change the host name on the FortiGate

Go to System > Settings and type in the new name in the Host name row. The only administrators that can
change a FortiGate’s host name are administrators whose admin profiles permit system configuration write
access. If the FortiGate is part of an HA cluster, you should use a unique host name to distinguish the FortiGate
from others in the cluster.

Central Management

You can manage any size Fortinet security infrastructure, from a few devices to thousands of appliances, by using
FortiManager or FortiCloud. You can configure your FortiGate for either of these centralized security
management services through Central Management. Be sure that you have registered your device with the
FortiManager appliance or FortiCloud host. For more information on configuring your FortiGate for Central
Management, see Adding a FortiGate to FortiManager or FortiCloud.

System Time

For effective scheduling and logging, the FortiGate system time and date should be accurate. You can either
manually set the system time and date or configure the FortiGate to automatically synchronize with a Network
Time Protocol (NTP) server.

NTP enables you to keep the FortiGate time synchronized with other network systems. By enabling NTP on the
FortiGate, FortiOS will check with the NTP server you select at the configured intervals. This will also ensure that
logs and other time-sensitive settings on the FortiGate are correct.
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The FortiGate maintains its internal clock using a built-in battery. At start up, the time reported by the FortiGate
will indicate the hardware clock time, which may not be accurate. When using NTP, the system time might
change after the FortiGate has successfully obtained the time from a configured NTP server.

By default, FortiOS has the daylight savings time configuration enabled. The system
time must be manually adjusted after daylight saving time ends. To disable DST,
enter the following commands in the CLI:

config system global
set dst disable

end

To set the date and time

1. Go to the System > Settings.
2. Under System Time, select your Time Zone by using the drop-down menu.
3. Set Time by either selecting Synchronize with NTP Server orManual settings. If you select synchronization,

you can either use the default FortiGuard servers or specify a custom server. You can also set the Sync interval.
4. If you use an NTP server, you can identify a specific interface for this self-originating traffic by enabling Setup

device as local NTP server.
5. Select Apply.

Administration Settings

In order to improve security, you can change the default port configurations for administrative connections to the
FortiGate. When connecting to the FortiGate when the port has changed, the port must be included, such as
https://<ip_address>:<port>. For example, if you are connecting to the FortiGate using port 99, the
URL would be https://192.168.1.99:99.

To configure the port settings:

1. Go to System > Settings.
2. UnderAdministration Settings, change the port numbers for HTTP, HTTPS, SSH, and/or Telnet as needed.

You can also select Redirect to HTTPS in order to avoid HTTP being used for the administrators.
3. Select Apply.
When you change the default port number for HTTP, HTTPS, SSH, or Telnet, ensure that the port number is
unique. If a conflict exists with a particular port, a warning message will appear.

By default, the GUI disconnects administrative sessions if no activity occurs for five minutes. This prevents
someone from using the GUI if the management PC is left unattended.

To change the idle timeout

1. Go to System > Settings.
2. In the Administration Settings section, enter the time in minutes in the Idle timeout field.
3. Select Apply.
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Password Policy

The FortiGate includes the ability to create a password policy for administrators and IPsec pre-shared keys. With
this policy, you can enforce regular changes and specific criteria for a password including:

l minimum length between 8 and 64 characters.
l if the password must contain uppercase (A, B, C) and/or lowercase (a, b, c) characters.
l if the password must contain numbers (1, 2, 3).
l if the password must contain special or non-alphanumeric characters (!, @, #, $, %, ^, &, *, (, and )).
l where the password applies (admin or IPsec or both).
l the duration of the password before a new one must be specified.

To create a password policy - GUI

1. Go to System > Settings.
2. Configure Password Policy settings as required.
3. ClickApply.

If you add a password policy or change the requirements on an existing policy, the next time that administrator
logs into the FortiGate, they are prompted to update their password to meet the new requirements before
proceeding to log in.

For information about recovering a lost password and enhancements to the process, see: Resetting a lost Admin
password on the Fortinet Cookbook site.

View Settings

Three settings can change the presentation of information in the GUI: Language, Lines per page, and Theme.

To change the language, go to System > Settings. Select the language you want from the Language drop-
down list: English (the default), French, Spanish, Portuguese, Japanese, Traditional Chinese, Simplified
Chinese, or Korean. For best results, you should select the language that is used by the management computer.

To change the number of lines per page displayed in the GUI tables, set Lines per page to a value between 20
and 1,000. The default is 50 lines per page.

Five color themes are currently available: Green (the default), Red, Blue, Melongene, and Mariner. To change
your theme, select the color from the Theme drop-down list.

This is also where you select either Flow-based or Proxy Inspection Mode . If you select Flow-based mode,
then you need to specify if it isNGFW Profile-based orNGFW Policy-based inspection.

Administrator password retries and lockout time

By default, the FortiGate sets the number of password retries at three, allowing the administrator a maximum of
three attempts to log into their account before locking the account for a set amount of time.

Both the number of attempts (admin-lockout-threshold) and the wait time before the administrator can
try to enter a password again (admin-lockout-duration) can be configured within the CLI.

To configure the lockout options:

config system global
set admin-lockout-threshold <failed_attempts>
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set admin-lockout-duration <seconds>
end

The default value of admin-lockout-threshold is 3 and the range of values is between 1 and 10. The
admin-lockout-duration is set to 60 seconds by default and the range of values is between 1 and
4294967295 seconds.

Keep in mind that the higher the lockout threshold, the higher the risk that someone may be able to break into the
FortiGate unit.

Example:

To set the admin-lockout-threshold to one attempt and the admin-lockout-duration to a five
minute duration before the administrator can try to log in again, enter the commands:

config system global
set admin-lockout-threshold 1
set admin-lockout-duration 300

end

If the time span between the first failed login attempt and the admin-lockout-
threshold failed login attempt is less than admin-lockout-duration, the
lockout will be triggered.

Passwords
Using secure passwords are vital for preventing unauthorized access to your FortiGate. When changing the
password, consider the following to ensure better security:

l Do not make passwords that are obvious, such as the company name, administrator names, or other obvious words
or phrases.

l Use numbers in place of letters, for example, passw0rd.
l Administrator passwords can be up to 64 characters.
l Include a mixture of letters, numbers, and upper and lower case.
l Use multiple words together, or possibly even a sentence, for example keytothehighway.
l Use a password generator.
l Change the password regularly and always make the new password unique and not a variation of the existing

password, such as changing from password to password1.
l Make note of the password and store it in a safe place away from the management computer, in case you forget it

or ensure that at least two people know the password in the event that one person becomes ill, is away on vacation,
or leaves the company. Alternatively, have two different admin logins.

Downgrades will typically maintain the administrator password. If you need to downgrade to FortiOS 4.3, remove
the password before the downgrade, then log in after the downgrade and re-configure the password.

Password policy

The FortiGate includes the ability to create a password policy for administrators and IPsec pre-shared keys. With
this policy, you can enforce regular changes and specific criteria for a password including:

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

343



Basic Administration

l minimum length between 8 and 64 characters.
l if the password must contain uppercase (A, B, C) and/or lowercase (a, b, c) characters.
l if the password must contain numbers (1, 2, 3).
l if the password must contain special or non-alphanumeric characters (!, @, #, $, %, ^, &, *, (, and )).
l where the password applies (admin or IPsec or both).
l the duration of the password before a new one must be specified.

To create a password policy - GUI

1. Go to System > Settings.
2. Configure Password Policy settings as required.
3. ClickApply.

If you add a password policy or change the requirements on an existing policy, the next time that administrator
logs into the FortiGate, they are prompted to update their password to meet the new requirements before
proceeding to log in.

For information about recovering a lost password and enhancements to the process, see: Resetting a lost Admin
password on the Fortinet Cookbook site.
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Firmware
Fortinet periodically updates the FortiGate firmware to include new features and resolve important issues. After
you have registered your FortiGate unit, you can download firmware updates from the support web site,
https://support.fortinet.com.

Before you install any new firmware, be sure to follow the steps below:

l Review the Release Notes for a new firmware release.
l Review the Supported Upgrade Paths Sys Admin note on the Fortinet Cookbook site to make sure the upgrade from

your current image to the desired new image is supported.
l Backup the current configuration, including local certificates.
l Test the new firmware until you are satisfied that it applies to your configuration.

Installing new firmware without reviewing release notes or testing the firmware may result in changes to settings
or unexpected issues.

Only FortiGate admin users and administrators whose access profiles contain system
read and write privileges can change the FortiGate firmware.

Backing up the current configuration

You should always back up the configuration before installing new firmware, in case you need to restore your
FortiGate configuration.

To create a local backup:

1. Open to the administrator's dropdown menu in the top-right corner of the GUI and select Configuration
> Backup.

2. Choose either Local PC orUSB Disk to save the configuration file. The USB option will not be available if there
is no USB drive in the USB port.

3. If desired, select Encryption.
4. Select OK.
For more information, see Configuration Backups.

Downloading firmware

Firmware images for all FortiGate units are available on the Fortinet Customer Support website,
https://support.fortinet.com.

To download firmware:

1. Log into the site using your user name and password.
2. Go to Download > Firmware Images.
3. A list of Release Notes is shown. If you have not already done so, download and review the Release Notes for the

firmware you wish to upgrade your FortiGate unit to.
4. Select Download.
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Firmware can also be downloaded using FTP; however, as FTP is not an encrypted file
transferring protocol, HTTPS downloading is recommended.

5. Navigate to the folder for the firmware version you wish to use.
6. Select your FortiGate model from the list. If your unit is a FortiWiFi, the firmware will have a filename starting with

'FWF'.
7. Save the firmware image to your computer.

Testing new firmware

The integrity of firmware images downloaded from Fortinet's support portal can be verified using a file checksum.
A file checksum that does not match the expected value indicates a corrupt file. The corruption could be caused
by errors in transfer or by file modification. A list of expected checksum values for each build of released code is
available on Fortinet’s support portal.

Image integrity is also verified when the FortiGate is booting up. This integrity check is done through a cyclic
redundancy check (CRC). If the CRC fails, the FortiGate unit will encounter an error during the boot process.

Lastly, firmware images are signed and the signature is attached to the code as it is built. When upgrading an
image, the running OSwill generate a signature and compare it with the signature attached to the image. If the
signatures do not match, the new OSwill not load.

Testing before installation

FortiOS lets you test a new firmware image by installing the firmware image from a system reboot and saving it to
system memory. After completing this procedure, the FortiGate unit operates using the new firmware image with
the current configuration. This new firmware image is not permanently installed. The next time the FortiGate unit
restarts, it operates with the originally installed firmware image using the current configuration. If the new
firmware image operates successfully, you can install it permanently using the procedure explained in Testing
new firmware on page 346.

To use this procedure, you must connect to the CLI using the FortiGate console port and an RJ-45 to DB-9 or null
modem cable. This procedure temporarily installs a new firmware image using your current configuration.

For this procedure, you must install a TFTP server that you can connect to from the FortiGate internal interface.
The TFTP server should be on the same subnet as the internal interface.

To test the new firmware image:

1. Connect to the CLI using an RJ-45 to DB-9 or null modem cable.
2. Make sure the TFTP server is running.
3. Copy the new firmware image file to the root directory of the TFTP server.
4. Make sure the FortiGate unit can connect to the TFTP server using the execute ping command.
5. Enter the following command to restart the FortiGate unit:

execute reboot

6. As the FortiGate unit reboots, press any key to interrupt the system startup. As the FortiGate unit starts, a series
of system startup messages appears:

Press any key to display configuration menu....
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7. Immediately press any key to interrupt the system startup.

You have only three (3) seconds to press any key. If you do not press a key quickly
enough, the FortiGate unit reboots and you must log in and repeat the execute
reboot command.

If you successfully interrupt the startup process, the following messages appears:

[G]: Get firmware image from TFTP server.
[F]: Format boot device.
[B]: Boot with backup firmware and set as default
[C]: Configuration and information
[Q]: Quit menu and continue to boot with default firmware.
[H]: Display this list of options.
Enter G, F, Q, or H:

8. TypeG to get the new firmware image from the TFTP server. The following message appears:

Enter TFTP server address [192.168.1.168]:

9. Type the address of the TFTP server and pressEnter. The following message appears:
Enter Local Address [192.168.1.188]:

10. Type an IP address of the FortiGate unit to connect to the TFTP server. The IP address must be on the same
network as the TFTP server.

Make sure you do not enter the IP address of another device on this network.

The following message appears:

Enter File Name [image.out]:

11. Enter the firmware image file name and pressEnter. The TFTP server uploads the firmware image file to the
FortiGate unit and the following appears.

Save as Default firmware/Backup firmware/Run image without saving: [D/B/R]

12. Type R. The FortiGate image is installed to system memory and the FortiGate unit starts running the new
firmware image, but with its current configuration.

You can test the new firmware image as required. When done testing, you can reboot the FortiGate unit, and the
FortiGate unit will resume using the firmware that was running before you installed the test firmware.

Upgrading the firmware

Installing firmware replaces your current antivirus and attack definitions, along with the definitions included with
the firmware release you are installing. After you install new firmware, make sure that antivirus and attack
definitions are up to date. You can also use the CLI command execute update-now to update the antivirus
and attack definitions.

Always remember to back up your configuration before making any changes to the
firmware.

Be sure to read the topics on downloading and testing firmware before upgrading.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

347



Basic Administration

To upgrade the firmware - GUI:

1. Log into the GUI as the admin administrative user.
2. Go to System > Firmware.
3. UnderUpload Firmware, select Browse and locate the firmware image file.
4. Select OK.
The FortiGate unit uploads the firmware image file, upgrades to the new firmware version, restarts, and displays
the FortiGate login. This process takes a few minutes.

You can also upgrade firmware using Secure File Copy (SCP). See How to
download/upload a FortiGate configuration file using secure file copy (SCP).

You enable SCP support using the following command:
config system global
   set admin-scp enable
end
For more information about this command and about SCP support, see config system
global.

To upgrade the firmware - CLI:

Before you begin, ensure you have a TFTP server running and accessible to the FortiGate unit.

1. Make sure the TFTP server is running.
2. Copy the new firmware image file to the root directory of the TFTP server.
3. Log into the CLI.
4. Make sure the FortiGate unit can connect to the TFTP server. You can use the following command to ping the

computer running the TFTP server. For example, if the IP address of the TFTP server is 192.168.1.168:

execute ping 192.168.1.168

5. Enter the following command to copy the firmware image from the TFTP server to the FortiGate unit:

execute restore image tftp <filename> <tftp_ipv4>

Where <name_str> is the name of the firmware image file and <tftp_ipv4> is the IP address of
the TFTP server. For example, if the firmware image file name is image.out and the IP address of
the TFTP server is 192.168.1.168, enter:

execute restore image tftp image.out 192.168.1.168

The FortiGate unit responds with the message:

This operation will replace the current firmware version!
Do you want to continue? (y/n)

6. Type y. The FortiGate unit uploads the firmware image file, upgrades to the new firmware version, and restarts.
This process takes a few minutes.

7. Reconnect to the CLI.
8. Update antivirus and attack definitions, by entering:

execute update-now
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Reverting to a previous firmware version

The following procedure reverts the FortiGate unit to its factory default configuration and deletes any
configuration settings. If you are reverting to a previous FortiOS version, you might not be able to restore the
previous configuration from the backup configuration file.

Always remember to back up your configuration before making any changes to the
firmware.

To revert to a previous firmware version - GUI:

1. Log into the GUI as the admin user.
2. Go to System > Firmware.
3. UnderUpload Firmware, select Browse and locate the firmware image file.
4. Select OK.
The FortiGate unit uploads the firmware image file, reverts to the old firmware version, resets the configuration,
restarts, and displays the FortiGate login. This process takes a few minutes.

To revert to a previous firmware version - CLI:

Before beginning this procedure, it is recommended that you:

l Backup the FortiGate unit system configuration using the command
execute backup config.

l Backup the IPS custom signatures using the command execute
backup ipsuserdefsig.

l Backup web content and email filtering lists.

To use the following procedure, you must have a TFTP server the FortiGate unit can connect to.

1. Make sure the TFTP server is running.
2. Copy the firmware image file to the root directory of the TFTP server.
3. Log into the FortiGate CLI.
4. Make sure the FortiGate unit can connect to the TFTP server by using the execute ping command.
5. Enter the following command to copy the firmware image from the TFTP server to the FortiGate unit:

execute restore image tftp <name_str> <tftp_ipv4>

Where <name_str> is the name of the firmware image file and <tftp_ipv4> is the IP address of
the TFTP server. For example, if the firmware image file name is imagev28.out and the IP
address of the TFTP server is 192.168.1.168, enter:

execute restore image tftp image28.out 192.168.1.168

The FortiGate unit responds with this message:

This operation will replace the current firmware version!
Do you want to continue? (y/n)

6. Type y. The FortiGate unit uploads the firmware image file. After the file uploads, a message similar to the
following appears:

Get image from tftp server OK.
Check image OK.
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This operation will downgrade the current firmware version!
Do you want to continue? (y/n)

7. Type y. The FortiGate unit reverts to the old firmware version, resets the configuration to factory defaults, and
restarts. This process takes a few minutes.

8. Reconnect to the CLI.
9. To restore your previous configuration, if needed, use the command:

execute restore config <name_str> <tftp_ipv4>

10. Update antivirus and attack definitions using the command:

execute update-now

Installing firmware from a system reboot - CLI

In the event that the firmware upgrade does not load properly and the FortiGate unit will not boot, or continuously
reboots, it is best to perform a fresh install of the firmware from a reboot using the CLI.

This procedure installs a firmware image and resets the FortiGate unit to default settings. You can use this
procedure to upgrade to a new firmware version, revert to an older firmware version, or re-install the current
firmware.

To use this procedure, you must connect to the CLI using the FortiGate console port and a RJ-45 to DB-9, or null
modem cable. This procedure reverts the FortiGate unit to its factory default configuration.

For this procedure you install a TFTP server that you can connect to from the FortiGate internal interface. The
TFTP server should be on the same subnet as the internal interface.

Before beginning this procedure, ensure you backup the FortiGate unit configuration.

If you are reverting to a previous FortiOS version, you might not be able to restore the previous configuration from
the backup configuration file.

Installing firmware replaces your current antivirus and attack definitions, along with the definitions included with
the firmware release you are installing. After you install new firmware, make sure that antivirus and attack
definitions are up to date.

To install firmware from a system reboot:

1. Connect to the CLI using the RJ-45 to DB-9 or null modem cable.
2. Make sure the TFTP server is running.
3. Copy the new firmware image file to the root directory of the TFTP server.
4. Make sure the internal interface is connected to the same network as the TFTP server.
5. To confirm the FortiGate unit can connect to the TFTP server, use the following command to ping the computer

running the TFTP server. For example, if the IP address of the TFTP server is 192.168.1.168:

execute ping 192.168.1.168

6. Enter the following command to restart the FortiGate unit.

execute reboot

The FortiGate unit responds with the following message:

This operation will reboot the system!
Do you want to continue? (y/n)
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7. Type y. As the FortiGate unit starts, a series of system startup messages appears. When the following messages
appears:

Press any key to display configuration menu..........

Immediately press any key to interrupt the system startup.

You have only three (3) seconds to press any key. If you do not press a key quickly
enough, the FortiGate unit reboots and you must log in and repeat the execute
reboot command.

If you successfully interrupt the startup process, the following messages appears:

[G]: Get firmware image from TFTP server.
[F]: Format boot device.
[B]: Boot with backup firmware and set as default
[C]: Configuration and information
[Q]: Quit menu and continue to boot with default firmware.
[H]: Display this list of options.
Enter G, F, Q, or H:

8. TypeG to get to the new firmware image form the TFTP server. The following message appears:

Enter TFTP server address [192.168.1.168]:

9. Type the address of the TFTP server and pressEnter. The following message appears:
Enter Local Address [192.168.1.188]:

10. Type an IP address the FortiGate unit can use to connect to the TFTP server. The IP address can be any IP
address that is valid for the network to which the interface is connected.

Make sure you do not enter the IP address of another device on this network.

The following message appears:

Enter File Name [image.out]:

11. Enter the firmware image filename and pressEnter.
The TFTP server uploads the firmware image file to the FortiGate unit and a message similar to the following
appears:

Save as Default firmware/Backup firmware/Run image without saving: [D/B/R]

12. Type D. The FortiGate unit installs the new firmware image and restarts. The installation might take a few
minutes to complete.

Restoring firmware from a USB key - CLI

1. Log into the CLI.
2. Enter the following command to restore an unencrypted configuration file:

execute restore image usb Restore image from USB disk.

{string} Image file name on the USB disk.

The FortiGate unit responds with the following message:

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

351



Basic Administration

This operation will replace the current firmware version!
Do you want to continue? (y/n)

3. Type y.

Configuration revision

You can manage multiple versions of configuration files on models that have a 512MB flash memory and higher.
Revision control requires either a configured central management server or the local hard drive, if your FortiGate
has this feature. Typically, configuration backup to local drive is not available on lower-end models.

The central management server can either be a FortiManager unit or FortiCloud.

If central management is not configured on your FortiGate unit, a message appears instructing you to either:

l Enable central management, or
l obtain a valid license.

When revision control is enabled on your FortiGate unit, and configuration backups have been made, a list of
saved revisions of those backed-up configurations appears.

Configuration revisions are viewed by clicking on admin in the upper right-hand corner of the screen and
selecting Configuration > Revisions.

Controlled upgrade

Using a controlled upgrade, you can upload a new version of the FortiOS firmware to a separate partition in the
FortiGate memory for later upgrade. The FortiGate unit can also be configured so that when it is rebooted, it will
automatically load the new firmware (CLI only). Using this option, you can stage a number of FortiGate units to
do an upgrade simultaneously to all devices using FortiManager or script.

To load the firmware for later installation - CLI:

execute restore secondary-image {ftp | tftp | usb} <filename_str>

To set the FortiGate unit so that when it reboots, the new firmware is loaded, use the CLI command . . .

execute set-next-reboot {primary | secondary}

where {primary | secondary} is the partition with the preloaded firmware.

Configuration Backups
Once you successfully configure the FortiGate, it is extremely important that you backup the configuration. In
some cases, you may need to reset the FortiGate to factory defaults or perform a TFTP upload of the firmware,
which will erase the existing configuration. In these instances, the configuration on the device will have to be
recreated, unless a backup can be used to restore it. You should also backup the local certificates, as the unique
SSL inspection CA and server certificates that are generated by your FortiGate by default are not saved in a
system backup.

It is also recommended that you backup the configuration after any future changes are made, to ensure you have
the most current configuration available. Also, backup the configuration before any upgrades of the FortiGate’s
firmware. Should anything happen to the configuration during the upgrade, you can easily restore the saved
configuration.
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Always backup the configuration and store it on the management computer or off-site. You have the option to
save the configuration file to various locations including the local PC, USB key, FTP, and TFTP server. The last
two are configurable through the CLI only.

If you have VDOMs, you can back up the configuration of the entire FortiGate or only a specific VDOM. Note that
if you are using FortiManager or FortiCloud, full backups are performed and the option to backup individual
VDOMs will not appear.

You can also backup and restore your configuration using Secure File Copy (SCP).
See How to download/upload a FortiGate configuration file using secure file copy
(SCP).

You enable SCP support using the following command:
config system global
   set admin-scp enable
end
For more information about this command and about SCP support, see config system
global.

Backing up the configuration using the GUI

1. Click on admin in the upper right-hand corner of the screen and select Configuration > Backup.
2. Direct the backup to your Local PC or to a USB Disk.

The USB Disk option will be grayed out if no USB drive is inserted in the USB port. You can also backup to
the FortiManager using the CLI.

3. If VDOMs are enabled, indicate whether the scope of the backup is for the entire FortiGate configuration (Global)
or only a specific VDOM configuration (VDOM).

4. If backing up a VDOM configuration, select the VDOM name from the list.
5. Select Encryption.

Encryption must be enabled on the backup file to back up VPN certificates.

6. Enter a password and enter it again to confirm it. You will need this password to restore the file.
7. Select OK.
8. The web browser will prompt you for a location to save the configuration file. The configuration file will have a

.conf extension.

Backing up the configuration using the CLI

Use one of the following commands:

execute backup config management-station <comment>

or:

execute backup config usb <backup_filename> [<backup_password>]

or for FTP, note that port number, username are optional depending on the FTP site:

execute backup config ftp <backup_filename> <ftp_server> [<port>] [<user_name>]
[<password>]

or for TFTP:

execute backup config tftp <backup_filename> <tftp_servers> <password>
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Use the same commands to backup a VDOM configuration by first entering the commands:

config vdom
edit <vdom_name>

Backup and restore the local certificates

This procedure exports a server (local) certificate and private key together as a password protected PKCS12 file.
The export file is created through a customer-supplied TFTP server. Ensure that your TFTP server is running and
accessible to the FortiGate before you enter the command.

To back up the local certificates:

Connect to the CLI and use the following command:

execute vpn certificate local export tftp <cert_name> <filename> <tftp_ip>

where:

l <cert_name> is the name of the server certificate.
l <filename> is a name for the output file.
l <tftp_ip> is the IP address assigned to the TFTP server host interface.

To restore the local certificates - GUI:

1. Move the output file from the TFTP server location to the management computer.
2. Go to System > Certificates and select Import.
3. Select the appropriate type of certificate from the dropdown menu and fill in any required fields.
4. Select Upload. Browse to the location on the management computer where the exported file has been saved,

select the file and select Open.
5. If required, enter the Password needed to upload the exported file.
6. Select OK.

To restore the local certificates - CLI:

Connect to the CLI and use the following command:

execute vpn certificate local import tftp <filename> <tftp_ip>

Restore a configuration

Should you need to restore a configuration file, use the following steps:

To restore the FortiGate configuration - GUI:

1. Click on admin in the upper right-hand corner of the screen and select Configuration > Restore.
2. Identify the source of the configuration file to be restored : your Local PC or a USB Disk.

The USB Disk option will be grayed out if no USB drive is inserted in the USB port. You can restore from the
FortiManager using the CLI.

3. Enter the path and file name of the configuration file, or select Browse to locate the file.
4. Enter a password if required.
5. Select Restore.
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To restore the FortiGate configuration - CLI:

execute restore config management-station normal 0

or:

execute restore config usb <filename> [<password>]

or for FTP, note that port number, username are optional depending on the FTP site:

execute restore config ftp <backup_filename> <ftp_server> [<port>] [<user_name>]
[<password>]

or for TFTP:

execute restore config tftp <backup_filename> <tftp_server> <password>

The FortiGate will load the configuration file and restart. Once the restart has completed, verify that the
configuration has been restored.

Troubleshooting

During the installation, some possible errors may occur, but the solutions are usually straightforward.

Error message Reason and Solution

Configuration file error This error occurs when attempting to upload a configuration file that is
incompatible with the device. This may be due to the configuration file being for a
different model or being saved from a different version of firmware.

Solution: Upload a configuration file that is for the correct model of FortiGate
device and the correct version of the firmware.

Invalid password When the configuration file is saved, it can be protected by a password. The
password entered during the upload process is not matching the one associated
with the configuration file.

Solution: Use the correct password if the file is password protected.

Configuration revision

You can manage multiple versions of configuration files on models that have a 512MB flash memory and higher.
Revision control requires either a configured central management server or the local hard drive, if your FortiGate
has this feature. Typically, configuration backup to local drive is not available on lower-end models.

The central management server can either be a FortiManager unit or FortiCloud.

If central management is not configured on your FortiGate unit, a message appears instructing you to either:

l Enable central management, or
l obtain a valid license.

When revision control is enabled on your FortiGate unit, and configuration backups have been made, a list of
saved revisions of those backed-up configurations appears.

Configuration revisions are viewed by clicking on admin in the upper right-hand corner of the screen and
selecting Configuration > Revisions.
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Restore factory defaults

There may be a need to reset the FortiGate to its original defaults; for example, to begin with a fresh
configuration. There are two options when restoring factory defaults. The first resets the entire device to the
original out-of-the-box configuration.

You can reset using the CLI by entering the command:

execute factoryreset

When prompted, type y to confirm the reset.

Alternatively, in the CLI you can reset the factory defaults but retain the interface and VDOM configuration. Use
the following command:

execute factoryreset2

FortiGuard
The FortiGuard Distribution Network (FDN) of servers provides updates to antivirus, antispam, and IPS
definitions to your FortiGate. FortiGuard Subscription Services provides comprehensive Unified Threat
Management (UTM) security solutions to enable protection against content and network level threats.

The FortiGuard team can be found around the globe, monitoring virus, spyware and vulnerability activities. As
vulnerabilities are found, signatures are created and pushed to the subscribed FortiGates. The Global Threat
Research Team enables Fortinet to deliver a combination of multi-layered security intelligence and provide true
zero-day protection from new and emerging threats. The FortiGuard Network has data centers around the world
located in secure, high availability locations that automatically deliver updates to the Fortinet security platforms
to protect the network with the latest information.

FortiGuard provides a number of services to monitor world-wide activity and provide the best possible security,
including:

l Intrusion Prevention System (IPS) - IPS uses a customizable database of more than 4000 known threats to stop
attacks that evade conventional firewall defenses. It also provides behavior-based heuristics, enabling the system
to recognize threats when no signature has yet been developed. It also provides more than 1000 application identity
signatures for complete application control.

l Application Control - Application Control allows you to identify and control applications on networks and
endpoints regardless of port, protocol, and IP address used. It gives you unmatched visibility and control over
application traffic, even traffic from unknown applications and sources. Application Control is a free FortiGuard
service and the database for Application Control signatures is separate from the IPS database (Botnet Application
signatures are still part of the IPS signature database since these are more closely related with security issues and
less about application detection). Application Control signature database information is displayed under the
System > FortiGuard page in the FortiCare section.

Please note that while the Application Control profile can be used for free, signature
database updates require a valid FortiGuard subscription.

l AntiVirus -The FortiGuard AntiVirus Service provides fully automated updates to ensure protection against the
latest content level threats. It employs advanced virus, spyware, and heuristic detection engines to prevent both
new and evolving threats from gaining access to your network and protects against vulnerabilities.
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l Web Filtering - Web Filtering providesWeb URL filtering to block access to harmful, inappropriate, and dangerous
web sites that may contain phishing/pharming attacks, malware such as spyware, or objectionable content that can
expose your organization to legal liability. Based on automatic research tools and targeted research analysis, real-
time updates enable you to apply highly-granular policies that filter web access based on six major categories and
nearly 80 micro-categories, over 45 million rated web sites, and more than two billion web pages - all continuously
updated.

l Vulnerability Scanning - FortiGuard Services provide comprehensive and continuous updates for vulnerabilities,
remediation, patch scan, and configuration benchmarks.

l Email Filtering - The FortiGuard Antispam Service uses both a sender IP reputation database and a spam
signature database, along with sophisticated spam filtering tools on Fortinet appliances and agents, to detect and
block a wide range of spam messages. Updates to the IP reputation and spam signature databases are provided
continuously via the FDN.

l Messaging Services - Messaging Services allow a secure email server to be automatically enabled on your
FortiGate to send alert email or send email authentication tokens. With the SMS gateway, you can enter phone
numbers where the FortiGate will send the SMSmessages. Note that depending on your carrier, there may be a
slight time delay on receiving messages.

l DNS and DDNS - The FortiGuard DNS and DDNS services provide an efficient method of DNS lookups once
subscribed to the FortiGuard network. This is the default option. The FortiGate connects automatically to the
FortiGuard DNS server. If you do not register, you need to configure an alternate DNS server.

Configure the DDNS server settings using the CLI command:

config system fortiguard
set ddns-server-ip
set ddns-server-port

end

Support Contract and FortiGuard Subscription Services

The FDN support Contract is available under System > FortiGuard.

The License Information area displays the status of your FortiGate’s support contract.

You can also manually update the AntiVirus and IPS engines.

Verifying your connection to FortiGuard

If you are not getting FortiGuard web filtering or antispam services, there are a few things to verify that
communication to the FDN is working. Before any troubleshooting, ensure that the FortiGate has been registered
and subscribed to the FortiGuard services.

Verification - GUI:

The simplest method to check that the FortiGate is communicating with the FDN, is to check the License
Information dashboard widget. Any subscribed services should have a green check mark beside them indicating
that connections are successful. Any other icon indicates a problem with the connection, or you are not
subscribed to the FortiGuard services.

You can also view the FortiGuard connection status by going to System > FortiGuard.

Verification - CLI:

You can also use the CLI to see what FortiGuard servers are available to your FortiGate. Use the following CLI
command to ping the FDN for a connection:
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execute ping guard.fortinet.net

You can also use the following diagnose command to find out what FortiGuard servers are available:

diagnose debug rating

From this command, you will see output similar to the following:

Locale : english
License : Contract
Expiration : Sun Jul 24 20:00:00 2011
Hostname : service.fortiguard.net
-=- Server List (Tue Nov 2 11:12:28 2010) -=-

IP Weight RTT Flags TZ Packets Curr Lost Total Lost
69.20.236.180 0 10 -5 77200 0 42
69.20.236.179 0   12 -5   52514     0 34
66.117.56.42 0 32 -5 34390 0 62
80.85.69.38 50  164 0   34430 0 11763
208.91.112.194 81  223 D -8   42530 0 8129
216.156.209.26 286 241 DI -8   55602 0 21555

An extensive list of servers are available. Should you see a list of three to five available servers, the FortiGuard
servers are responding to DNS replies to service FortiGuard.net, but the INIT requests are not reaching FDS
services on the servers.

The rating flags indicate the server status:

D Indicates the server was found via the DNS lookup of the hostname. If the hostname returns
more than one IP address, all of them will be flagged with 'D' and will be used first for INIT
requests before falling back to the other servers.

I Indicates the server to which the last INIT request was sent.

F The server has not responded to requests and is considered to have failed.

T The server is currently being timed.

The server list is sorted first by weight and then the server with the smallest RTT is put at the top of the list,
regardless of weight. When a packet is lost, it will be resent to the next server in the list.

The weight for each server increases with failed packets and decreases with successful packets. To lower the
possibility of using a distant server, the weight is not allowed to dip below a base weight, which is calculated as
the difference in hours between the FortiGate and the server, multiplied by 10. The further away the server, the
higher its base weight and the lower in the list it will appear.

Port assignment

The FortiGate contacts FDN for the latest list of FDN servers by sending UDP packets with typical source ports of
1027 or 1031, and destination port 8888. The FDN reply packets have a destination port of 1027 or 1031.

If your ISP blocks UDP packets in this port range, the FortiGate cannot receive the FDN reply packets. As a result,
the FortiGate will not receive the complete FDN server list.

If your ISP blocks the lower range of UDP ports (around 1024), you can configure your FortiGate to use higher-
numbered ports, using the CLI command:

config system global
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set ip-src-port-range <start port>-<end port>
end

where the <start port> and <end port> are numbers ranging of 1024 to 25000.

For example, you could configure the FortiGate to not use ports lower than 2048 or ports higher than the
following range:

config system global
set ip-src-port-range 2048-20000

end

Trial and error may be required to select the best source port range. You can also contact your ISP to determine
the best range to use. Push updates might be unavailable if:

l there is a NAT device installed between the unit and the FDN, and/or
l your unit connects to the Internet using a proxy server.

Configuring AntiVirus and IPS Options

Go to System > FortiGuard, and scroll down to the AntiVirus & IPS Updates section to configure the
antivirus and IPS options for connecting and downloading definition files.

Accept push
updates

Select to allow updates to be sent automatically to your FortiGate. New definitions will
be added as soon as they are released by FortiGuard.

Use override
push

Appears only if Accept push updates is enabled.

Enable to configure an override server if you cannot connect to the FDN or if your
organization provides updates using their own FortiGuard server. Once enabled,
enter the following:

l Enter the IP address and port of the NAT device in front of your FortiGate. FDSwill
connect to this device when attempting to reach the FortiGate.

l The NAT device must be configured to forward the FDS traffic to the FortiGate on
UDP port 9443.

Scheduled
Updates

Enable for updates to be sent to your FortiGate at a specific time. For example, to
minimize traffic lag times, you can schedule the update to occur on weekends or after
work hours.

Note that a schedule of once a week means any urgent updates will not be pushed
until the scheduled time. However, if there is an urgent update required, select the
Update Now button.

Improve IPS
quality

Enable to help Fortinet maintain and improve IPS signatures. The information sent to
the FortiGuard servers when an attack occurs can be used to keep the database
current as variants of attacks evolve.

Use extended IPS
signature
package

Regular IPS database protects against the latest common and in-the-wild attacks.
Extended IPS database includes protection from legacy attacks.

Update AV & IPS
Definitions

Select to manually initiate an FDN update.
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Manual updates

To manually update the signature definitions file, you need to first go to the Support web site at
https://support.fortinet.com. Once logged in, select Download > FortiGuard Service Updates. The browser
will present you the most current IPS and AntiVirus signature definitions which you can download.

Once downloaded to your computer, log into the FortiGate to load the definition file.

To load the definition file onto the FortiGate:

1. Go to System > FortiGuard.
2. In the License Information table, select the Upgrade Database link in either the Application Control

Signature, IPS, orAntiVirus row.
3. In the pop-up window, select Upload and locate the downloaded file and select Open.

The upload may take a few minutes to complete.

Automatic updates

The FortiGate can be configured to request updates from FDN on a scheduled basis, or via push notification.

Scheduling updates

Scheduling updates ensures that the virus and IPS definitions are downloaded to your FortiGate on a regular
basis, ensuring that you do not forget to check for the definition files yourself.

Updating definitions can cause a very short disruption in traffic currently being scanned while the FortiGate unit
applies the new signature database, Ideally, schedule updates during off-peak hours, such as evenings or
weekends, when network usage is minimal, to ensure that the network activity will not suffer from the added
traffic of downloading the definition files.

To enable scheduled updates - GUI:

1. Go to System > FortiGuard and scroll down to AntiVirus & IPS Updates.
2. Enable Scheduled Updates.
3. Select the frequency of updates.
4. Select Apply.

To enable scheduled updates - CLI:

config system autoupdate schedule
set status enable
set frequency {every | daily | weekly}
set time <hh:mm>
set day <day_of_week>

end

Push updates

Push updates enable you to get immediate updates when new viruses or intrusions have been discovered and
new signatures created. This ensures that the latest signature will be sent to the FortiGate as soon as possible.
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When a push notification occurs, the FortiGuard server sends a notice to the FortiGate that there is a new
signature definition file available. The FortiGate then initiates a download of the definition file, similar to the
scheduled update.

To ensure maximum security for your network, you should have a scheduled update as well as enable the push
update, in case an urgent signature is created, and your cycle of the updates only occurs weekly.

To enable push updates - GUI:

1. Go to System > FortiGuard and scroll down to AntiVirus & IPS Updates.
2. Enable Accept push updates.
3. Select Apply.

To enable push updates - CLI:

config system autoupdate push-update
set status enable

end

Push IP override

If the FortiGate is behind another NAT device (or another FortiGate), to ensure it receives the push update
notifications, you need to use an override IP address for the notifications. To do this, you create a virtual IP to
map to the external port of the NAT device.

Generally speaking, if there are two FortiGate devices, the following steps need to be completed on the
FortiGate NAT device to ensure the FortiGate on the internal network receives the updates:

l Add a port forwarding virtual IP to the FortiGate NAT device that connects to the Internet by going to Policy
& Objects > Virtual IPs.

l Add a security policy to the FortiGate NAT device that connects to the Internet that includes the port forwarding
virtual IP.

l Configure the FortiGate on the internal network with an override push IP and port.

On the FortiGate internal device, the virtual IP is entered as the Use push override IP address.

To enable push update override- GUI:

1. Go to System > FortiGuard and scroll down to AntiVirus & IPS Updates.
2. Enable Accept push updates.
3. Enable Use override push.
4. Enter the virtual IP address configured on the NAT device.
5. Select Apply.

To enable push updates - CLI:

config system autoupdate push-update
set status enable
set override enable
set address <vip_address>

end
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Sending malware statistics to FortiGuard

To support following malware trends and making zero-day discoveries, FortiGate units send encrypted statistics
to FortiGuard about IPS, Application Control, and AntiVirus events detected by the FortiGuard services running
on your FortiGate. FortiGuard uses the statistics collected to achieve a balance between performance and
security effectiveness by moving inactive signatures to an extended signature database.

The statistics include some non-personal information that identifies your FortiGate and its country. The
information is never shared with external parties. You can choose to disable the sharing of this information by
entering the following CLI command:

config system global
set fds-statistics disable

end

Configuring Web Filtering and Email Filtering Options

Go to System > FortiGuard, and scroll down to Filtering to set the size of the caches and ports.

Web Filter Cache Set the Time To Live (TTL) value. This is the number of seconds the
FortiGate will store a blocked IP or URL locally, saving time and network
access traffic, checking the FortiGuard server. Once the TTL has expired,
the FortiGate will contact an FDN server to verify a web address. The TTL
must be between 300 and 86400 seconds.

Anti-Spam Cache Set the TTL value (see above).

FortiGuard Filtering Port Select the port assignments for contacting the FortiGuard servers.

Filtering Service
Availability

Indicates the status of the filtering service. Select Check Again if the
filtering service is not available.

Request re-evaluation of a
URL's category

Select to re-evaluate a URL’s category rating on the FortiGuard Web Filter
service.

Email filtering

The FortiGuard data centers monitor and update email databases of known spam sources. With FortiGuard Anti-
Spam filtering enabled, the FortiGate verifies incoming email sender addresses and IPs against the database,
and takes the necessary actions as defined within the antivirus profiles.

Spam source IP addresses can also be cached locally on the FortiGate, providing a quicker response time, while
easing load on the FortiGuard servers, aiding in a quicker response time for less common email address
requests.

By default, the anti-spam cache is enabled. The cache includes a TTL value, which is the amount of time an
email address will stay in the cache before expiring. You can change this value to shorten or extend the time
between 5 and 1,440 minutes.

To modify the antispam cache TTL - GUI:

1. Go to System > FortiGuard.
2. Under Filtering, enable Anti-Spam Cache.
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3. Enter the TTL value in minutes.
4. Select Apply.

To modify the Anti-Spam filter TTL - CLI:

config system fortiguard
set antispam-cache-ttl <integer>

end

Further antispam filtering options can be configured to block, allow, or quarantine specific email addresses.
These configurations are available through the Security Profiles > Anti-Spammenu.

Online Security Tools

The FortiGuard online center provides a number of online security tools, including but not limited to:

l URL lookup — By entering a website address, you can see if it has been rated and what category and
classification it is filed as. If you find your website or a site you commonly go to has been wrongly categorized, you
can use this page to request that the site be re-evaluated.
https://fortiguard.com/webfilter

l Threat Encyclopedia — Browse the Fortiguard Labs extensive encyclopedia of threats. Search for viruses, botnet
C&C, IPS, endpoint vulnerabilities, and mobile malware.
https://www.fortiguard.com/encyclopedia

l Application Control — Browse the Fortiguard Labs extensive encyclopedia of applications.
https://fortiguard.com/appcontrol

FortiCloud
FortiCloud is a hosted security management and log retention service for FortiGate devices. It gives you
centralized reporting, traffic analysis, configuration management, and log retention without the need for
additional hardware or software.

FortiCloud offers a wide range of features:

l Simplified central management— FortiCloud provides a central web-based management console to manage
individual or aggregated FortiGate and FortiWiFi devices. Adding a device to the FortiCloud management
subscription is straightforward. FortiCloud has detailed traffic and application visibility across the whole network.

l Hosted log retention with large default storage allocated— Log retention is an integral part of any security
and compliance program but administering a separate storage system is burdensome. FortiCloud takes care of this
automatically and stores the valuable log information in the cloud. Each device is allowed up to 200GB of log
retention storage. Different types of logs can be stored including Traffic, System Events, Web, Applications, and
Security Events.

l Monitoring and alerting in real time— Network availability is critical to a good end-user experience. FortiCloud
enables you to monitor your FortiGate network in real time with different alerting mechanisms to pinpoint potential
issues. Alerting mechanisms can be delivered via email.

l Customized or pre-configured reporting and analysis tools — Reporting and analysis are your eyes and
ears into your network’s health and security. Pre-configured reports are available, as well as custom reports that can
be tailored to your specific reporting and compliance requirements. For example, you may want to look closely at
application usage or website violations. The reports can be emailed as PDFs and can cover different time periods.
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l Maintain important configuration information uniformly— The correct configuration of the devices within
your network is essential to maintaining an optimum performance and security posture. In addition, maintaining the
correct firmware (operating system) level allows you to take advantage of the latest features.

l Service security— All communication (including log information) between the devices and the clouds is
encrypted. Redundant data centers are always used to give the service high availability. Operational security
measures have been put in place to make sure your data is secure — only you can view or retrieve it.

Registration and Activation

Before you can activate a FortiCloud account, you must first register your device.

FortiCloud accounts can be registered manually through the FortiCloud website, https://www.forticloud.com, but
you can easily register and activate your account directly from your FortiGate.

Activating your FortiCloud Account

1. On your device’s dashboard, in the FortiCloud widget, select the Activate button in the status field.
2. A dialogue asking you to register your FortiCloud account appears. Select Create Account, enter your

information, view and accept the terms and conditions, and select OK.
3. A second dialogue window appears, asking you to enter your information to confirm your account. This sends a

confirmation email to your registered email. The dashboard widget then updates to show that confirmation is
required.

4. Open your email, and follow the confirmation link it contains.

Results

A FortiCloud page will open, stating that your account has been confirmed. The Activation Pending message on
the dashboard will change to state the type of account you have (‘1GB Free’ or ‘200GB Subscription’), and will
provide a link to the FortiCloud portal.

Enabling logging to FortiCloud

1. Go to Log & Report > Log Settings.
2. Enable Send Logs to FortiCloud.
3. Select Test Connectivity to ensure that your FortiGate can connect to the registered FortiCloud account.
4. Scroll down toGUI Preferences, set Display Logs/FortiView From, to see FortiCloud logs within the

FortiGate's GUI.

Logging into the FortiCloud portal

Once logging has been configured and you have registered your account, you can log into the FortiCloud portal
and begin viewing your logging results. There are two methods to reach the FortiCloud portal:

l If you have direct networked access to the FortiGate, you can simply open yourDashboard and check the License
Information widget. Next to the current FortiCloud connection status will be a link to reach the FortiCloud Portal.

l If you do not currently have access to the FortiGate’s interface, you can visit the FortiCloud website
(https://forticloud.com) and log in remotely, using your email and password. It will ask you to confirm the FortiCloud

364 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

https://www.forticloud.com/
https://forticloud.com/


Basic Administration

account you are connecting to and then you will be granted access. Connected devices can be remotely configured
using the Scripts page in the Management Tab, useful if an administrator may be away from the unit for a long
period of time.

Cloud Sandboxing

FortiCloud can be used for automated sample tracking, or sandboxing, for files from a FortiGate. This allows
suspicious files to be sent to be inspected without risking network security. If the file exhibits risky behavior, or is
found to contain a virus, a new virus signature is created and added to the FortiGuard antivirus signature
database.

Cloud sandboxing is configured by going to Security Fabric > Settings. After enabling Sandbox Inspection,
select the FortiSandbox type.

Sandboxing results are shown in a new tab called AV Submissions in the FortiCloud portal. This tab only
appears after a file has been sent for sandboxing.

For more information about FortiCloud, see the FortiCloud documentation.
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Troubleshooting your FortiGate Installation

If your FortiGate does not function as desired after installation, try the following troubleshooting tips:

1. Use FortiExplorer if you can’t connect to the FortiGate over Ethernet
If you can’t connect to the FortiGate GUI or CLI, you may be able to connect using FortiExplorer. Refer to the
QuickStart Guide or see the section on the FortiExplorer for more details.

2. Check for equipment issues
Verify that all network equipment is powered on and operating as expected. Refer to the QuickStart Guide for
information about connecting your FortiGate to the network. You will also find detailed information about the
FortiGate LED indicators.

3. Check the physical network connections
Check the cables used for all physical connections to ensure that they are fully connected and do not appear
damaged, and make sure that each cable connects to the correct device and the correct Ethernet port on that
device.

4. Verify that you can connect to the internal IP address of the FortiGate
Connect to the GUI from the FortiGate’s internal interface by browsing to its IP address. From the PC, try to ping
the internal interface IP address; for example, ping 192.168.1.99.
If you cannot connect to the internal interface, verify the IP configuration of the PC. If you can ping the interface
but can't connect to the GUI, check the settings for administrative access on that interface.

5. Check the FortiGate interface configurations
Check the configuration of the FortiGate interface connected to the internal network by going to Network
> Interfaces and make sure Addressing mode is set to the correct mode.

6. Verify the security policy configuration
Go to Policy & Objects > IPv4 Policy and verify that the internal interface to Internet-facing interface security
policy has been added and is located near the top of the policy list. Check the Active Sessions column to ensure
that traffic has been processed (if this column does not appear, right-click on the title row, select Active
Sessions).
If you are using NAT mode, check the configuration of the policy to make sure that NAT is enabled and that Use
Outgoing Interface Address is selected.

7. Verify that you can connect to the Internet-facing interface’s IP address
Ping the IP address of the FortiGate’s Internet-facing interface. If you cannot connect to the interface, the
FortiGate is not allowing sessions from the internal interface to Internet-facing interface.

8. Verify the static routing configuration
Go to Network > Static Routes and verify that the default route is correct. Go toMonitor > Routing Monitor
and verify that the default route appears in the list as a static route. Along with the default route, you should see
two routes shown asConnected, one for each connected FortiGate interface.

9. Verify that you can connect to the gateway provided by your ISP
Ping the default gateway IP address from a PC on the internal network. If you cannot reach the gateway, contact
your ISP to verify that you are using the correct gateway.

10. Verify that you can communicate from the FortiGate to the Internet
Access the FortiGate CLI and use the command execute ping 8.8.8.8. You can also use the execute
traceroute 8.8.8.8 command to troubleshoot connectivity to the Internet.

11. Verify the DNS configurations of the FortiGate and the PCs
Check for DNS errors by pinging or using traceroute to connect to a domain name; for example: ping
www.fortinet.com.
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If the name cannot be resolved, the FortiGate or PC cannot connect to a DNS server and you should confirm that
the DNS server IP addresses are present and correct.

12. Confirm that the FortiGate can connect to the FortiGuard network
Once registered, the FortiGate obtains AntiVirus and Application Control and other updates from the FortiGuard
network. Once the FortiGate is on your network, you should confirm that it can reach the FortiGuard network.
First, check the License Information widget to make sure that the status of all FortiGuard services matches the
services that you have purchased.
Go to System > FortiGuard. Scroll down to Filtering Services Availability and select Check Again. After a
minute, the GUI should indicate a successful connection.

13. Consider changing the MAC address of your external interface
Some ISPs do not want the MAC address of the device connecting to their network cable to change. If you have
added a FortiGate to your network, you may have to change the MAC address of the Internet-facing interface
using the following CLI command:

config system interface
edit <interface>

set macaddr <xx:xx:xx:xx:xx:xx>
end

end

14. Either reset the FortiGate to factory defaults or contact Fortinet Support for assistance. See the note below before
contacting support.
To reset the FortiGate to factory defaults, use the CLI command execute factoryreset. When prompted,
type y to confirm the reset.

You can also contact Fortinet Support for assistance. Read the following article found on the Fortinet Cookbook
website: How to work with Fortinet Support to understand what type of support is available and to determine
which level of support is right for you. For further information, go to support.fortinet.com.
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Resources

Here's a list of some resources you can check out next to help you get the most out of your newly installed and
configured FortiGate.

Best Practices
The Best Practices document is a collection of guidelines to ensure the most secure and reliable operation of
FortiGates in a customer environment. It is updated periodically as new issues are identified.

This document can be found at http://docs.fortinet.com/.

The Fortinet Cookbook
The Fortinet Cookbook contains a variety of step-by-step examples of how to integrate a FortiGate into your
network and apply features such as security profiles, wireless networking, and VPN.

Using the Cookbook, you can go from idea to execution in simple steps, configuring a secure network for better
productivity with reduced risk.

The Fortinet Cookbook can be found at http://cookbook.fortinet.com.

The Fortinet Video Library
The Fortinet Video Library contains video tutorials showing how to configure various Fortinet products, including
FortiGates. Many FortiGate videos are based on recipes from the FortiGate Cookbook.

The Fortinet Video Library can be found at http://video.fortinet.com. You can also subscribe to Fortinet's
YouTube channel.

The FortiOS Handbook
The FortiOS Handbook is the complete guide to FortiOS, covering a variety of FortiGate configurations. The
Handbook is available as a single complete document online. Handbook chapters are also available as
standalone documents.

The FortiOS Handbook can be found at http://docs.fortinet.com/.
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Chapter 3 - Authentication

Authentication

Welcome and thank you for selecting Fortinet products for your network protection.

This chapter contains the following topics:

l Before you begin
l How this guide is organized

Before you begin
Before you begin using this guide, please ensure that:

l You have administrative access to the web-based manager and/or CLI.
l The FortiGate unit is integrated into your network.
l The operation mode has been configured.
l The system time, DNS settings, administrator password, and network interfaces have been configured.
l Firmware, FortiGuard Antivirus and FortiGuard Antispam updates are completed.
l Any third-party software or servers have been configured using their documentation.

While using the instructions in this guide, note that administrators are assumed to be super_admin administrators
unless otherwise specified. Some restrictions will apply to other administrators.

How this guide is organized
This Handbook chapter contains the following sections:

Introduction to authentication describes some basic elements and concepts of authentication.

Authentication servers describes external authentication servers, where a FortiGate unit fits into the topology,
and how to configure a FortiGate unit to work with that type of authentication server.

Users and user groups describes the different types of user accounts and user groups. Authenticated access to
resources is based on user identities and user group membership. Two-factor authentication methods, including
FortiToken, provide additional security.

Managing Guest Access explains how to manage temporary accounts for visitors to your premises.

Configuring authenticated access provides detailed procedures for setting up authenticated access in security
policies and authenticated access to VPNs.

Captive portals describes how to authenticate users through a web page that the FortiGate unit presents in
response to any HTTP request until valid credentials are entered. This can be used for wired or WiFi network
interfaces.

Certificate-based authentication describes authentication by means of X.509 certificates.
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Single Sign-On using a FortiAuthenticator unit describes how to use a FortiAuthenticator unit as an SSO agent
that can integrate with external network authentication systems such as RADIUS and LDAP to gather user logon
information and send it to the FortiGate unit. Users can also log on through a FortiAuthenticator-based web portal
or the FortiClient SSO Mobility Agent.

Single Sign-On to Windows AD describes how to set up Single Sign-On in a Windows AD network by configuring
the FortiGate unit to poll domain controllers for information user logons and user privileges.

Agent-based FSSO describes how to set up Single Sign-On in Windows AD, Citrix, or Novell networks by
installing Fortinet Single Sign On (FSSO) agents on domain controllers. The FortiGate unit receives information
about user logons and allows access to network resources based on user group memberships.

SSO using RADIUS accounting records describes how to set up Single Sign-On in a network that uses RADIUS
authentication. In this configuration, the RADIUS server send RADIUS accounting records to the FortiGate unit
when users log on or off the network. The record includes a user group name that can be used in FortiGate
security policies to determine which resources each user can access.

Monitoring authenticated users describes FortiOS authenticated user monitor screens.

Examples and Troubleshooting provides configuration examples and troubleshooting suggestions.
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This chapter describes new authentication features added to FortiOS 5.6.

FortiOS 5.6.4
These features first appeared in FortiOS 5.6.4.

l "Authentication binds to MAC address" on page 382
l "RADIUS accounting start message options" on page 394
l "IPv6 TACACS+ server IP address" on page 407
l "Login credentials for guest users shown in clear text on GUI and voucher" on page 429

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Certificate Import page updates (267949)

The importation of a non-CA certificate into FortiGate CA store now shows a warning message showing why the
import didn't work (as expected).

Improvements to the execute fortitoken import command (401979)

The execute fortitoken import command has been removed and replaced by three new commands,
allowing the importation of FortiToken seed files from either an FTP server, a TFTP server, or a USB drive:

l execute fortitoken import ftp <file name> <ip>[:ftp port] <Enter> <user>
<password>

l execute fortitoken import tftp <file name> <ip>

l execute fortitoken import usb <file name>

These commands allow seed files to be imported from an external source more easily.

Improved 2FA workflow in GUI (405487, 409100, 444430, 446856, 456752)

Various improvements to the two-factor authentication workflow in the GUI which addressed the following issues:

l No email was sent after creating an administrator account with a FortiToken.
l Inconsistent view on admin and user dialog.
l Empty activation codes would be sent.
l If Norway was selected as the country code for a user, the phone number was not recognized after saving.
l Couldn't select custom SMS server when setting the phone number.
l When a FortiToken from a non-management VDOM was selected for an admin, the activation code wouldn't be

sent.
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Support FTM Push when FortiAuthenticator is the authentication server (408273, 438314)

FortiGate supports when the FortiAuthenticator initiates FTM Push notifications, for when users are attempting
to authenticate through a VPN and/or RADIUS (with FortiAuthenticator as the RADIUS server).

Support exact match for subject and CN fields in peer user (416359)

Administrators can now specify which way a peer user authenticates, in order to avoid any unintentional admin
access by a regular user. When searching for a matching certificate, use the commands below to control how to
find matches in the certificate subject name (subject-match) or the cn attribute (cn-match) of the certificate
subject name. This match can be any string (substring) or an exact match (value) of the cn attribute value.

Syntax

config vpn certificate setting
edit <name>

set subject-match {substring | value}
set cn-match {substring | value}

next
end

FortiToken GUI improvement (435229)

Various FortiToken import functionalities have been improved in the GUI, including the ability to import from
serial number file correctly, validation of serial numbers once imported, and removing the Activate button once a
token has already been activated.

Improve FTM Push notification workflow (436642, 448734)

Updated GUI and logincheck module to use a non-blocking version of the FTM Push notification procedure and
periodically polls the device for any status updates from fam daemon.

FortiClient shares Social ID data with FortiOS (438610)

Support has been added to record the social ID data from FortiClient so that if an email or phone number is
changed on FortiClient, the new values are updated on the FortiGate.

The data will be sent in KeepAlive messages in the following format:

USR_NAME|<full name for the service account>|USR_EMAIL|<email for the service
account>|SERVICE|<os|custom|linkedin|google|salesforce>|

Wildcard certificate support/handling for SAN/CN reference identifiers (440307)

As a requirement of Network Device Collaborative Protection Profile (NDcPP), FortiOS supports and handles the
use of wildcards for the following certificate reference parameters:

l Subject Alternative Name (SAN)
l Common Name (CN)

Support for FTP and TFTP to update certificates (441695)

Support has been added for FTP and TFTP servers to update the certificate bundle using a new execute
command.
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Syntax

execute vpn certificate ca import bundle <file-name.pkg> <ftp/tftp-server-ip>

Global option to enable/disable SHA1 algorithm inSSH key exchanges (444827)

Support has been added for a global option top enable/disable SHA1 algorithm in SSH key exchanges. The
algorithm is enabled by default and provides administrators with the ability to disable the option for the purposes
of security and compliance testing.

Syntax

config system global
set ssh-kex-sha1 {enable | disable}

end

Support for HTTP tunnel authentication (449406)

Support has been added for an option to trigger user authentication on HTTPCONNECT request at the policy
level. A new CLI entry has been added under config firewall proxy-policy which will trigger the
authentication process get-user, even when there is no user or group configured.

Note that, as shown below, explicit web proxy must be set.

Syntax

config firewall proxy-policy
edit {policyid}

set proxy explicit-web
set http-tunnel-auth {enable | disable}

next
end

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

IPv6 RADIUS Support (309235, 402437, 439773)

RADIUS authentication is supported with IPv6, allowing administrators to configure an IPv6 RADIUS server on
the FortiGate for IPv6 RADIUS authentication traffic to pass between the server and FortiGate.

Note that while you can set the primary RADIUS server's IPv6 address, the source IP
address for communications to the RADIUS server cannot be configured as IPv6.

Syntax

Allow IPv6 access on an interface:

config system interface
edit <name>

config ipv6
set ip6-allowaccess {ping | https | ssh | snmp | http | telnet | fgfm | capwap}
set ip6-address <xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx/xxx>
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next
next

end

Configure the IPv6 RADIUS server:

config user radius
edit <name>

set server <xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx>
...

next
end

Full certificate chain CRL checking (407988)

Certificate revocation/status check for peer certificates and intermediate CAs is now supported. Redesigned
fnbam_auth_cert() API to use stack type of X509 instead of array for certificate chain. Removed obsolete fnbam
API and parameters. Now authd, sslvpnd, and GUI send full certificate chains to fnbamd for verification.

New option under user > setting to allow/forbid SSL renegotiation in firewall authentication
(386595)

A new option auth-ssl-allow-renegotiation is now available under config user setting to
allow/forbid renegotiation. The default value is disable, where a session would be terminated by authd once
renegotiation is detected and this login would be recorded as failure. Other behavior follows regular auth settings.

Syntax

config user setting
set auth-ssl-allow-renegotiation {enable | disable}

end

New option to allow spaces in RADIUS DN format (422978)

Previously, IKEv2 RADIUS group authentication introduced a regression because it removed spaces from ASN.1
DN peer identifier string.

Reverted default DN format to include spaces. Added a new CLI option ike-dn-format to allow the user to
select either with-space or no-space. Customers using the group-authentication option can select
the ike-dn-format setting to match the format used in their RADIUS user database.

Added LDAP filter when group-member-check is user-attr (403140)

Added LDAP filter when group-member-check is user-attr. LDAP filter is deployed when checking user
attribute.

Syntax

config user ldap
edit <name>

set group-filter ?
next

end

l group-filter is none by default, where the process is the same as before.
When group-filter is set, the LDAP filter takes effect for retrieving the group information.
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Added Refresh button to the LDAP browser (416649)

Previously, cached LDAP data was used even if the LDAP server configuration was updated.

In FortiOS 5.6.1, a Refresh button has been added in the LDAP browser. In the LDAP server dialog page, the
user can delete the DN field to browse the root level tree when clicking the Fetch DN button.

Differentiate DN option for user authentication and membership searching (435791)

Previously, LDAP used the same DN option for user authentication and membership searching. New CLI
commands are introduced to config user ldap to resolve this issue:

l group-member-check user-attr
For user attribute checking, a new attribute group-search-base is added, which indicates the starting point for
the group search. If the group-search-base is not set, binddn is used as the search base. Removed search-
type when group-member-check is user-attr.

l group-member-check group-object
For group object checking, the group names in user group match rule will be picked up as the group search base. If
there are multiple matching rules, each group name will trigger the ldapsearch query once.

l group-member-check posix-group-object
Changed group-object-search-base to group-search-base for posix-group-object group-
member-check.

FTM Push when FAC is auth server (408273)

This feature adds support for FortiToken Mobile (FTM) push with FortiAuthenticator server in FortiOS. It also
fixes a crash when adding a node to an RB tree, by checking if the same key has already been used in the tree. If
yes, remove the node using the same key before adding a new node.

Non-blocking LDAP authentication (433700)

The previous LDAP authentication in fnbamd used openldap library. OpenLDAP supports non-blocking BIND but
it is not event driven.

To support non-blocking LDAP in fnbamd, we stopped using the openLDAP library in fnbamd, instead using only
liblber. Instead of using openLDAP, fnbamd will create its own event-driven connection with LDAP servers over
LDAP/LDAPS/STARTTLS, make it non-blocking, do CRL checking if necessary, and compose all LDAP requests
using liblber (including bind, unbind, search, password renewal, password query, send request and receive
response, and parse response). The whole process is done in one connection.

This doesn't change any openLDAP implementation but moves some data structure definitions and API
definitions from some internal header files to public header files.

Manual certificate SCEP renewal (423997)

Added support of manual certificate SCEP renewal besides the auto-regeneration feature that already exists.

More detailed RADIUS responses shown in connectivity test (434303)

Improved on-demand test connectivity for RADIUS servers. Test results show RADIUS server reachability, NAS
client rejection, and invalid User/Password. Test also shows RADIUS Attributes returned from the RADIUS
server.
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Example

FG100D3G12807101 # diagnose test authserver radius-direct
<server_name or IP> <port no(0 default port)> <secret> <user> <password>

FG100D3G12807101 # diagnose test authserver radius-direct 1.1.1.1 0 dd
RADIUS server '1.1.1.1' status is Server unreachable

FG100D3G12807101 # diagnose test authserver radius-direct 172.18.5.28 0 dd
RADIUS server '172.18.5.28' status is Secret invalid

FG100D3G12807101 # diagnose test authserver radius-direct 172.18.5.28 0 fortinet jeff1
asdfasdf

RADIUS server '172.18.5.28' status is OK
Access-Reject

FG100D3G12807101 # diagnose test authserver radius-direct 172.18.5.28 0 fortinet ychen1
asdfasdf

RADIUS server '172.18.5.28' status is OK
Access-Accept
AVP: l=6 t=Framed-Protocol(7)

Value: 1
AVP: l=6 t=Service-Type(6)

Value: 2
AVP: l=46 t=Class(25)

Value: 9e 2a 08 6d 00 00 01 37 00 01 17 00 fe 80 00 00 00 00 00 00 00 00 5e fe ac 12 05
1c 01 d2 cd b6 75 a6 80 56 00 00 00 00 00 00 00 1c

AVP: l=12 t=Vendor-Specific(26) v=Microsoft(311)
VSA: l=6 t=MS-Link-Utilization-Threshold(14)
Value: 50

AVP: l=12 t=Vendor-Specific(26) v=Microsoft(311)
VSA: l=6 t=MS-Link-Drop-Time-Limit(15)
Value: 120

User group authentication timeout range increased to 30 days (378085)

You can now use the following command to override the default user authentication timeout for users in a user
group to up to 30 days.

config user group
edit <group-name>

set authtimeout 43200
end

Where authtimeout is the length of the timeout in minutes. An authtimeout of 43200 minutes is equivalent
to 30 days. Set authtimeout to 0 to use the default authentication timeout.

FortiOS 5.6.0
These features first appeared in FortiOS 5.6.0.

FortiToken Mobile Push (397912, 408273, 399839, 404872)

FortiToken Mobile push supports two-factor authentication without requiring users to enter a four-digit code to
authenticate. Instead they can just accept the authentication request from their FortiToken Mobile app.
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A new command has been added under config system ftm-push allowing you to configure the FortiToken
Mobile Push services server IP address and port number. The Push service is provided by Apple (APNS) and
Google (GCM) for iPhone and Android smartphones respectively. This will help to avoid tokens becoming locked
after an already enabled two-factor authentication user has been disabled.

CLI syntax

config system ftm-push
set server-ip <ip-address>
set server-port [1-65535] Default is 4433.

end

If an SSL VPN user authenticates with their token, then logs out and attempts to reauthenticate again within a
minute, a new message will display showing "Please wait x seconds to login again." This replaces a previous
error/permission denied message.

The "x" value will depend on the calculation of how much time is left in the current time step.

CLI syntax

config system interface
edit <name>

set allowaccess ftm
next

end

Support V4 BIOS certificate (392960)

FortiOS now supports backwards compatibility between new BIOS version 4 and old BIOS version 3.

New BIOS V4 certificates:

l Fortinet_CA
l Fortinet_Sub_CA
l Fortinet_Factory

Old BIOS V3 certificates:

l Fortinet_CA_Backup
l Fortinet_Factory_Backup

When FortiOS connects to FortiGuard, FortiCloud, FortiManager, FortiAnalyzer, FortiSandbox as a client, the
new BIOS certificate Fortinet_Factorywill be the default client certificate. When the server returns its certificate
(chain) back, FortiOS looks up the issuer of the server certificate and either keeps client certificate as is or
switches to the old BIOS certificate Fortinet_Factory_Backup. This process occurs in one handshake.

When FortiOS connects to FortiCare, the new BIOS certificate Fortinet_Factory is the only client certificate and
Server Name Indication (SNI) is set. There is no switchover of certificate during SSL handshake.

When FortiOS acts as a server when connected by FortiExtender, FortiSwitch, FortiAP, etc., Fortinet_Factory is
the default server certificate. FortiOS detects SNI in client hello, and if no SNI is found or if the CN in SNI is
different from the CN of Fortinet_CA, it switches to use the old Fortinet_Factory_Backup.
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Support extendedKeyUsage for x.509 certificates (390393)

As per Network Device Collaborative Protection Profile (NDcPP) v1.0 requirements, server certificates used for
TLS connections between FortiGate and FortiAnalyzer should have the "Server Authentication" and "Client
Authentication" extendedKeyUsage fields in FIPS/CC mode.

To implement this, a new CLI command has been added under log fortianalyzer setting to allow you
to specify the certificate used to communicate with FortiAnalyzer.

CLI syntax

config log fortianalyzer setting
set certificate <name>

end

Administrator name added to system event log (386395)

The administrator's name now appears in the system event log when the admin issues a user quarantine ban on a
source address.

Support RSA-4096 bit key-length generation (380278)

In anticipation of quantum computers, RSA-4096 bit key-length CSRs can now be imported.

New commands added to config user ldap to set UPN processing method and filter name
(383561)

Added two new commands to config user ldap allowing you to keep or strip domain string of UPN in the
token as well as the search name for this kind of UPN.

CLI syntax:

config user ldap
set account-key-processing
set account-key-name

end

User authentication max timeout setting change (378085)

To accommodate wireless hotspot users authenticated on the FortiGate, the user authentication max timeout
setting has been extended to three days (from one day, previously).

Changes to Authentication Settings > Certificates GUI (374980)

Added new icons for certificate types and updated formatters to use these new icons.

Password for private key configurable in both GUI and CLI (374593)

FortiOS 5.4.1 introduced a feature that allowed you to export a local certificate and its private key in password
protected p12, and later import them to any device. This option to set password for private key was available only
in the CLI (when requesting a new certificate via SCEP or generating a CSR). This feature is now also
configurable through the GUI.

The new Password for private key option is available under System > Certificateswhen generating a new
CSR.
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RADIUS password encoding (365145)

A new CLI command, under config user radius, has been added to allow you to configure
RADIUS password encoding to use ISO-8859-1 (as per RFC 2865).

Certain RADIUS servers use ISO-8859-1 password encoding instead of others such as UTF-8. In these instances,
the server will fail to authenticate the user, if the user's password is using UTF-8.

CLI syntax

config user radius
edit <example>

set password-encoding <auto | ISO-8859-1>
end

This option will be skipped if the auth-type is neither auto nor pap.

RSSO supports Delegated-IPv6-Prefix and Framed-IPv6-Prefix (290990)

Two attributes, Delegated-IPv6-Prefix and Framed-IPv6-Prefix, have been introduced for RSSO to provide a
/56 prefix for DSL customers. All devices connected from the same location (/56 per subscriber) can be mapped
to the same profile without the need to create multiple /64 or smaller entries.
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Identifying users and other computers—authentication—is a key part of network security. This section describes
some basic elements and concepts of authentication.

The following topics are included in this section:

l What is authentication?
l Methods of authentication
l Types of authentication
l User’s view of authentication
l FortiGate administrator’s view of authentication

What is authentication?
Businesses need to authenticate people who have access to company resources. In the physical world this may
be a swipe card to enter the building, or a code to enter a locked door. If a person has this swipe card or code,
they have been authenticated as someone allowed in that building or room.

Authentication is the act of confirming the identity of a person or other entity. In the context of a private computer
network, the identities of users or host computers must be established to ensure that only authorized parties can
access the network. The FortiGate unit enables controlled network access and applies authentication to users of
security policies and VPN clients.

Methods of authentication
FortiGate unit authentication is divided into three basic types: password authentication for people, certificate
authentication for hosts or endpoints, and two-factor authentication for additional security beyond just passwords.
An exception to this is that FortiGate units in an HA cluster and FortiManager units use password authentication.

Password authentication verifies individual user identities, but access to network resources is based on
membership in user groups. For example, a security policy can be configured to permit access only to the
members of one or more user groups. Any user who attempts to access the network through that policy is then
authenticated through a request for their username and password.

Methods of authentication include:

l Local password authentication
l Server-based password authentication
l Certificate-based authentication
l Two-factor authentication

Local password authentication

The simplest authentication is based on user accounts stored locally on the FortiGate unit. For each account, a
username and password is stored. The account also has a disable option so that you can suspend the account
without deleting it.
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Local user accounts work well for a single-FortiGate installation. If your network has multiple FortiGate units that
will use the same accounts, the use of an external authentication server can simplify account configuration and
maintenance.

You can create local user accounts in the web-based manager underUser & Device > User Definition. This
page is also used to create accounts where an external authentication server stores and verifies the password.

Server-based password authentication

Using external authentication servers is desirable when multiple FortiGate units need to authenticate the same
users, or where the FortiGate unit is added to a network that already contains an authentication server. FortiOS
supports the use of LDAP, RADIUS, TACACS+, AD or POP3 servers for authentication.

When you use an external authentication server to authenticate users, the FortiGate unit sends the user’s
entered credentials to the external server. The password is encrypted. The server’s response indicates whether
the supplied credentials are valid or not.

You must configure the FortiGate unit to access the external authentication servers that you want to use. The
configuration includes the parameters that authenticate the FortiGate unit to the authentication server.

You can use external authentication servers in two ways:

l Create user accounts on the FortiGate unit, but instead of storing each user’s password, specify the server used to
authenticate that user. As with accounts that store the password locally, you add these users to appropriate user
groups.

l Add the authentication server to user groups. Any user who has an account on the server can be authenticated and
have the access privileges of the FortiGate user group. Optionally, when an LDAP server is a FortiGate user group
member, you can limit access to users who belong to specific groups defined on the LDAP server.

Certificate-based authentication

An RSA X.509 server certificate is a small file issued by a Certificate Authority (CA) that is installed on a computer
or FortiGate unit to authenticate itself to other devices on the network. When one party on a network presents the
certificate as authentication, the other party can validate that the certificate was issued by the CA. The
identification is therefore as trustworthy as the Certificate Authority (CA) that issued the certificate.

To protect against compromised or misused certificates, CAs can revoke any certificate by adding it to a
Certificate Revocation List (CRL). Certificate status can also be checked online using Online Certificate Status
Protocol (OCSP).

RSA X.509 certificates are based on public-key cryptography, in which there are two keys: the private key and the
public key. Data encrypted with the private key can be decrypted only with the public key and vice versa. As the
names suggest, the private key is never revealed to anyone and the public key can be freely distributed.
Encryption with the recipient’s public key creates a message that only the intended recipient can read. Encryption
with the sender’s private key creates a message whose authenticity is proven because it can be decrypted only
with the sender’s public key.

Server certificates contain a signature string encrypted with the CA’s private key. The CA’s public key is contained
in a CA root certificate. If the signature string can be decrypted with the CA’s public key, the certificate is genuine.

Certificate authorities

A certificate authority can be:
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l an organization, such as VeriSign Inc., that provides certificate services
l a software application, such as Microsoft Certificate Services or OpenSSH

For a company web portal or customer-facing SSL VPN, a third-party certificate service has some advantages.
The CA certificates are already included in popular web browsers and customers trust the third-party. On the
other hand, third-party services have a cost.

For administrators and for employee VPN users, the local CA based on a software application provides the
required security at low cost. You can generate and distribute certificates as needed. If an employee leaves the
organization, you can simply revoke their certificate.

Certificates for users

FortiGate unit administrators and SSL VPN users can install certificates in their web browsers to authenticate
themselves. If the FortiGate unit uses a CA-issued certificate to authenticate itself to the clients, the browser will
also need the appropriate CA certificate.

FortiGate IPsec VPN users can install server and CA certificates according to the instructions for their IPsec VPN
client software. The FortiClient Endpoint Security application, for example, can import and store the certificates
required by VPN connections.

FortiGate units are also compatible with some Public Key Infrastructure systems. For an example of this type of
system, see RSA ACE (SecurID) servers on page 410.

Two-factor authentication

A user can be required to provide both something they know (their username and password combination) and
something they have (certificate or a random token code). Certificates are installed on the user’s computer.

Two-factor authentication is available for PKI users. For more information, see Certificate on page 420.

Another type of two-factor authentication is to use a randomly generated token (multi-digit number) along with
the username and password combination. One method is a FortiToken — a one time passcode (OTP) generator
that generates a unique code every 60 seconds. Others use email or SMS text messaging to deliver the random
token code to the user or administrator.

When one of these methods is configured, the user enters this code at login after the username and password
have been verified. The FortiGate unit verifies the token code after as well as the password and username. For
more information, see Two-factor authentication on page 419

Authentication binds to MAC address

In FortiOS 5.4.3 and earlier, firewall authentication was source IP based, thus there was no action in response to
a MAC address change. This was a security flaw that allowed an unauthenticated user to access restricted
resources, especially in a Wi-Fi environment where the IP and MAC binding changed frequently.

FortiOS 5.6.4+ solves this issue by binding the MAC address with the user identity (auth logon) so that the MAC
address is matched while matching an auth logon.

Types of authentication
FortiOS supports two different types of authentication based on your situation and needs.

Security policy authentication is easily applied to all users logging on to a network, or network service. For
example if a group of users on your network such as the accounting department who have access to sensitive

382 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Introduction to authentication

data need to access the Internet, it is a good idea to make sure the user is a valid user and not someone trying to
send company secrets to the Internet. Security policy authentication can be applied to as many or as few users as
needed, and it supports a number of authentication protocols to easily fit with your existing network.

Virtual Private Network (VPN) authentication enables secure communication with hosts located outside the
company network, making them part of the company network while the VPN tunnel is operating. Authentication
applies to the devices at both ends of the VPN and optionally VPN users can be authenticated as well.

Security policy authentication

Security policies enable traffic to flow between networks. Optionally, the policy can allow access only to specific
originating addresses, device types, users or user groups. Where access is controlled by user or user group, users
must authenticate by entering valid username and password credentials.

The user’s authentication expires if the connection is idle for too long, five minutes by default but that can be
customized.

Security policies are the mechanism for FSSO, NTLM, certificate based, and RADIUS SSO authentication.

FSSO

Fortinet Single Sign on (FSSO) provides seamless authentication support for Microsoft Windows Active Directory
(AD) and Novell eDirectory users in a FortiGate environment.

On a Microsoft Windows or Novell network, users authenticate with the Active Directory or Novell eDirectory at
logon. FSSO provides authentication information to the FortiGate unit so that users automatically get access to
permitted resources. See Introduction to agent-based FSSO on page 508.

NTLM

The NT LANManager (NTLM) protocol is used when the MSWindows Active Directory (AD) domain controller
can not be contacted. NTLM is a browser-based method of authentication.

The FSSO software is installed on each AD server and the FortiGate unit is configured to communicate with each
FSSO client. When a user successfully logs into their Windows PC (and is authenticated by the AD Server), the
FSSO client communicates the user's name, IP address, and group login information to the FortiGate unit. The
FortiGate unit sets up a temporary access policy for the user, so when they attempt access through the firewall
they do not need to re-authenticate. This model works well in environments where the FSSO client can be
installed on all AD servers.

In system configurations where it is not possible to install FSSO clients on all AD servers, the FortiGate unit must
be able to query the AD servers to find out if a user has been properly authenticated. This is achieved using the
NTLM messaging features of Active Directory and Internet Explorer.

Even when NTLM authentication is used, the user is not asked again for their username and password. Internet
Explorer stores the user’s credentials and the FortiGate unit uses NTLM messaging to validate them in the
Windows AD environment.

Note that if the authentication reaches the timeout period, the NTLM message exchange restarts. For more
information on NTLM, see NTLM authentication on page 450 and FSSO NTLM authentication support on page
514.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

383



Introduction to authentication

Certificates

Certificates can be used as part of a policy. All users being authenticated against the policy are required to have
the proper certificate. See Certificate-based authentication on page 474

RADIUS SSO

RADIUS Single Sign-On (RSSO) is a remote authentication method that does not require any local users to be
configured, and relies on RADIUS Start records to provide the FortiGate unit with authentication information.
That information identifies the user and user group, which is then matched using a security policy. See SSO using
RADIUS accounting records on page 552.

FortiGuard Web Filter override authentication

Optionally, users can be allowed the privilege of overriding FortiGuard Web Filtering to view blocked web sites.
Depending on the override settings, the override can apply to the user who requested it, the entire user group to
which the user belongs, or all users who share the same web filter profile. As with other FortiGate features,
access to FortiGuard overrides is controlled through user groups. Firewall and Directory Services user groups are
eligible for the override privilege. For more information about web filtering and overrides, see the UTM chapter of
this FortiOS Handbook.

VPN authentication

Authentication involves authenticating the user. In IPsec VPNs authenticating the user is optional, but
authentication of the peer device is required.

This section includes:

l Authenticating IPsec VPN peers (devices)
l Authenticating IPsec VPN users
l Authenticating SSL VPN users
l Authenticating PPTP and L2TP VPN users

Authenticating IPsec VPN peers (devices)

A VPN tunnel has one end on a local trusted network, and the other end is at a remote location. The remote peer
(device) must be authenticated to be able to trust the VPN tunnel. Without that authentication, it is possible for a
malicious hacker to masquerade as a valid VPN tunnel device and gain access to the trusted local network.

The three ways to authenticate VPN peers are with a preshared key, RSA X.509 certificate, or a specific peer ID
value.

The simplest way for IPsec VPN peers to authenticate each other is through the use of a preshared key, also
called a shared secret. The preshared key is a text string used to encrypt the data exchanges that establish the
VPN tunnel. The preshared key must be six or more characters. The VPN tunnel cannot be established if the two
peers do not use the same key. The disadvantage of preshared key authentication is that it can be difficult to
securely distribute and update the preshared keys.

RSA X.509 certificates are a better way for VPN peers to authenticate each other. Each peer offers a certificate
signed by a Certificate Authority (CA) which the other peer can validate with the appropriate CA root certificate.
For more information about certificates, see Certificate-based authentication on page 474.
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You can supplement either preshared key or certificate authentication by requiring the other peer to provide a
specific peer ID value. The peer ID is a text string configured on the peer device. On a FortiGate peer or
FortiClient Endpoint Security peer, the peer ID provided to the remote peer is called the Local ID.

Authenticating IPsec VPN users

An IPsec VPN can be configured to accept connections from multiple dynamically addressed peers. You would do
this to enable employees to connect to the corporate network while traveling or from home. On a FortiGate unit,
you create this configuration by setting the Remote Gateway to Dialup User.

It is possible to have an IPsec VPN in which remote peer devices authenticate using a common preshared key or
a certificate, but there is no attempt to identify the user at the remote peer. To add user authentication, you can
do one of the following:

l require a unique preshared key for each peer
l require a unique peer ID for each peer
l require a unique peer certificate for each peer
l require additional user authentication (XAuth)

The peer ID is a text string configured on the peer device. On a FortiGate peer or FortiClient Endpoint Security
peer, the peer ID provided to the remote peer is called the Local ID.

Authenticating SSL VPN users

SSL VPN users can be

l user accounts with passwords stored on the FortiGate unit
l user accounts authenticated by an external RADIUS, LDAP or TACACS+ server
l PKI users authenticated by certificate

You need to create a user group for your SSL VPN. Simply create a firewall user group, enable SSL VPN access
for the group, and select the web portal the users will access.

SSL VPN access requires an SSL VPN security policy that permits access to members of your user group.

Authenticating PPTP and L2TP VPN users

PPTP and L2TP are older VPN tunneling protocols that do not provide authentication themselves. FortiGate units
restrict PPTP and L2TP access to users who belong to one specified user group. Users authenticate themselves
to the FortiGate unit by username/password. You can configure PPTP and L2TP VPNs only in the CLI. Before you
configure the VPN, create a firewall user group and add to it the users who are permitted to use the VPN. Users
are authenticated when they attempt to connect to the VPN. For more information about configuring PPTP or
L2TP VPNs, see the FortiGate CLI Reference.

Single Sign-On authentication for users
“Single Sign-On” means that users logged on to a computer network are authenticated for access to network
resources through the FortiGate unit without having to enter their username and password again. FortiGate units
directly provide Single Sign On capability for:

l Microsoft Windows networks using either Active Directory or NTLM authentication
l Novell networks, using eDirectory
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In combination with a FortiAuthenticator unit, the FortiGate unit can provide Single Sign-On capability that
integrates multiple external network authentication systems such asWindows Active Directory, Novell e-
Directory, RADIUS and LDAP. The FortiAuthenticator unit gathers user logon information from all of these
sources and sends it to the FortiGate unit.

Through the SSO feature, the FortiGate unit knows the username, IP address, and external user groups to which
the user belongs. When the user tries to access network resources, the FortiGate unit selects the appropriate
security policy for the destination. If the user belongs to one of the permitted user groups, the connection is
allowed.

For detailed information about SSO, see

l Single Sign-On using a FortiAuthenticator unit on page 496
l Agent-based FSSO on page 508

User’s view of authentication
From the user’s point of view, they see a request for authentication when they try to access a protected resource,
such as an FTP repository of intellectual property or simply access a website on the Internet. The way the request
is presented to the user depends on the method of access to that resource.

VPN authentication usually controls remote access to a private network.

Web-based user authentication

Security policies usually control browsing access to an external network that provides connection to the Internet.
In this case, the FortiGate unit requests authentication through the web browser.

The user types a username and password and then selectsContinue or Login. If the credentials are incorrect,
the authentication screen is redisplayed with blank fields so that the user can try again. When the user enters
valid credentials, access is granted to the required resource. In some cases, if a user tries to authenticate several
times without success, a message appears, such as: “Too many bad login attempts. Please try again in a few
minutes.” This indicates the user is locked out for a period of time. This prevents automated brute force password
hacking attempts. The administrator can customize these settings if required.

After a defined period of user inactivity (the authentication timeout, defined by the
FortiGate administrator), the user’s access expires. The default is 5 minutes. To
access the resource, the user will have to authenticate again.

VPN client-based authentication

A VPN provides remote clients with access to a private network for a variety of services that include web browsing,
email, and file sharing. A client program such as FortiClient negotiates the connection to the VPN and manages
the user authentication challenge from the FortiGate unit.

FortiClient can store the username and password for a VPN as part of the configuration for the VPN connection
and pass them to the FortiGate unit as needed. Or, FortiClient can request the username and password from the
user when the FortiGate unit requests them.
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Social ID data from FortiClient is recorded so that if an email or phone number is
changed on FortiClient, the new values are updated on the FortiGate.

The data is sent in KeepAlive messages in the following format:

USR_NAME|<full name for the service account>|USR_
EMAIL|<email for the service
account>|SERVICE|<os|custom|linkedin|google|salesforce>|

SSL VPN is a form of VPN that can be used with a standard Web browser. There are two modes of SSL VPN
operation (supported in NAT mode only):

l web-only mode, for remote clients equipped with a web-browser only
l tunnel mode, for remote computers that run a variety of client and server applications.

After a defined period of user inactivity on the VPN connection (the idle timeout,
defined by the FortiGate administrator), the user’s access expires. The default is 30
minutes. To access the resource, the user will have to authenticate again.

FortiGate administrator’s view of authentication
Authentication is based on user groups. The FortiGate administrator configures authentication for security
policies and VPN tunnels by specifying the user groups whose members can use the resource. Some planning is
required to determine how many different user groups need to be created. Individual user accounts can belong to
multiple groups, making allocation of user privileges very flexible.

A member of a user group can be:

l a user whose username and password are stored on the FortiGate unit
l a user whose name is stored on the FortiGate unit and whose password is stored on a remote or external

authentication server
l a remote or external authentication server with a database that contains the username and password of each

person who is permitted access

The general process of setting up authentication is as follows:

1. If remote or external authentication is needed, configure the required servers.
2. Configure local and peer (PKI) user identities. For each local user, you can choose whether the FortiGate unit or a

remote authentication server verifies the password. Peer members can be included in user groups for use in
security policies.

3. Create user groups.
4. Add local/peer user members to each user group as appropriate. You can also add an authentication server to a

user group. In this case, all users in the server’s database can authenticate. You can only configure peer user
groups through the CLI.

5. Configure security policies and VPN tunnels that require authenticated access.
For authentication troubleshooting, see the specific chapter for the topic or for general issues see
Troubleshooting on page 578.
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General authentication settings
Go to User & Device > Authentication Settings to configure authentication timeout, protocol support, and
authentication certificates.

When user authentication is enabled within a security policy, the authentication challenge is normally issued for
any of the four protocols (depending on the connection protocol):

l HTTP (can also be set to redirect to HTTPS)
l HTTPS
l FTP
l Telnet

The selections made in the Protocol Support list of Authentication Settings control which protocols support
the authentication challenge. Users must connect with a supported protocol first so they can subsequently
connect with other protocols. If HTTPS is selected as a method of protocol support, it allows the user to
authenticate with a customized Local certificate.

When you enable user authentication within a security policy, the security policy user will be challenged to
authenticate. For user ID and password authentication, users must provide their user names and passwords. For
certificate authentication (HTTPS or HTTP redirected to HTTPS only), you can install customized certificates on
the unit and the users can also have customized certificates installed on their browsers. Otherwise, users will see
a warning message and have to accept a default Fortinet certificate.

Authentication Timeout Enter a length of time in minutes, from 1 to 1440 minutes (24 hours).
Authentication timeout controls how long an authenticated firewall
connection can be idle before the user must authenticate again. The
default value is 5.

Protocol Support Select the protocols to challenge during firewall user authentication.

Certificate If using HTTPS protocol support, select the local certificate to use for
authentication. Available only if HTTPS protocol support is selected.

Apply Select to apply the selections for user authentication settings.
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FortiGate units support the use of external authentication servers. An authentication server can provide password
checking for selected FortiGate users or it can be added as a member of a FortiGate user group.

If you are going to use authentication servers, you must configure the servers before you configure FortiGate
users or user groups that require them.

Mac OS and iOS devices, including iPhones and iPads,
can perform user authentication with FortiOS units using
RADIUS servers, but not with LDAP or TACACS+
servers.

This section includes the following topics:

l FortiAuthenticator servers
l RADIUS servers
l LDAP servers
l TACACS+ servers
l POP3 servers
l SSO servers
l RSAACE (SecurID) servers

FortiAuthenticator servers
FortiAuthenticator is an Authentication, Authorization, and Accounting (AAA) server, that includes a RADIUS
server, an LDAP server, and can replace the FSSO Collector Agent on a Windows AD network. Multiple FortiGate
units can use a single FortiAuthenticator for FSSO, remote authentication, and FortiToken management.

For more information, see FortiAuthenticator documentation.

RADIUS servers
Remote Authentication and Dial-in User Service (RADIUS) is a broadly supported client-server protocol that
provides centralized authentication, authorization, and accounting functions. RADIUS clients are built into
gateways that allow access to networks such as Virtual Private Network servers, Network Access Servers (NAS),
as well as network switches and firewalls that use authentication. FortiGate units fall into the last category.

RADIUS servers use UDP packets to communicate with the RADIUS clients on the network to authenticate users
before allowing them access to the network, to authorize access to resources by appropriate users, and to
account or bill for those resources that are used. RADIUS servers are currently defined by RFC 2865 (RADIUS)
and RFC 2866 (Accounting), and listen on either UDP ports 1812 (authentication) and 1813 (accounting) or ports
1645 (authentication) and 1646 (accounting) requests. RADIUS servers exist for all major operating systems.

You must configure the RADIUS server to accept the FortiGate unit as a client. FortiGate units use the
authentication and accounting functions of the RADIUS server.
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FortiOS does not accept all characters from auto generated keys from MSWindows
2008. These keys are very long and as a result RADIUS authentication will not work.
Maximum key length for MSWindows 2008 is 128 bytes. In older versions of FSAE, it
was 40 bytes.

Microsoft RADIUS servers

Microsoft Windows Server 2000, 2003, and 2008 have RADIUS support built-in. Microsoft specific RADIUS
features are defined in RFC 2548. The Microsoft RADIUS implementation can use Active Directory for user
credentials.

For details on Microsoft RADIUS server configurations, refer to Microsoft documentation.

RADIUS user database

The RADIUS user database is commonly an SQL or LDAP database, but can also be any combination of:

l usernames and passwords defined in a configuration file
l user account names and passwords configured on the computer where the RADIUS server is installed.

If users are members of multiple RADIUS groups, then the user group authentication timeout value does not
apply. See Membership in multiple groups on page 431.

RADIUS authentication with a FortiGate unit

To use RADIUS authentication with a FortiGate unit

l configure one or more RADIUS servers on the FortiGate unit
l assign users to a RADIUS server

When a configured user attempts to access the network, the FortiGate unit will forward the authentication
request to the RADIUS server which will match the username and password remotely. Once authenticated the
RADIUS server passes the authorization granted message to the FortiGate unit which grants the user permission
to access the network.

The RADIUS server uses a “shared secret” key along with MD5 hashing to encrypt information passed between
RADIUS servers and clients, including the FortiGate unit. Typically only user credentials are encrypted. Additional
security can be configured through IPsec tunnels by placing the RADIUS server behind another VPN gateway.

RADIUS attribute value pairs

RADIUS packets include a set of attribute value pairs (AVP) to identify information about the user, their location
and other information. The FortiGate unit sends the following RADIUS attributes.

FortiOS supported RADIUS attributes

RADIUS
Attribute Name Description AVP

type

1 Acct-Session-ID Unique number assigned to each start and stop record to make
it easy to match them, and to eliminate duplicate records.

44

390 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Authentication servers

RADIUS
Attribute Name Description AVP

type

2 Username Name of the user being authenticated 1

3 NAS-Identifier Identifier or IP address of the Network Access Server (NAS) that
is requesting authentication. In this case, the NAS is the
FortiGate unit.

32

4 Framed-IP-Address Address to be configured for the user. 8

5 Fortinet-VSA See Vendor-specific attributes on page 392 26

6 Acct-Input-Octets

Number of octets received from the port over the course of this
service being provided.

Used to charge the user for the amount of traffic they used.

42

7 Acct-Output-Octets Number of octets sent to the port while delivering this service.

Used to charge the user for the amount of traffic they used.

43

8 NAS-IP-Address
IP address of the Network Access Server (NAS) that is
requesting authentication. In this case, the NAS is the
FortiGate unit.

4

9 Called-Station-Id Used to send the telephone number the user called as part of
the Access-Request packet.

30

10 Framed-IP-Address
IP address to be configured for the user, by sending the IP
address of a user to the RADIUS server in the Access-Request
packet.

8

11 Event-Timestamp Records the time that the event occurred on the NAS. The
timestamp is measured in seconds since January 1, 1970
00:00 UTC.

Before the Event-Timestamp attribute can be sent in a packet,
make sure that the correct time is set on the FortiGate.

55

12 Class
Used in accounting packets and requests for firewall, WiFi, and
proxy authentication. The attribute is returned in Access-Access
message and is added to all accounting packets.

25

The following table describes the supported authentication events and the RADIUS attributes that are sent in the
RADIUS accounting message.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

391



Authentication servers

RADIUS attributes sent in RADIUS accounting message

RADIUS Attributes

Authentication Method 1 2 3 4 5 6 7

Web X X X X

XAuth of IPsec (without
DHCP) X X X X

XAuth of IPsec (with DHCP) X X X X X

PPTP/L2TP (in PPP) X X X X X X X

SSL-VPN X X X X X

External captive portal POST message

In external RADIUS captive portal, the captive portal web page is a script that gathers the user’s logon credentials
and sends it back to the FortiGate as a POST message. Session URL parameters are sent from the client in a
POST messages, and in the redirect. These parameters are separated by& characters (see examples below):

POST message to redirect server:

http://<redirectserver>/index2.php/?login&post=http://192.168.200.1:1000/fgtau
th&magic=02050f889bc21644&usermac=54:26:96:16:a2:45&apmac=00:09:0f:b9:f4:c0&ap
ip=127.0.0.1&userip=192.168.200.2

POST message back to the FortiGate:

http://FGT_IP_addr:1000/fgtauth

The magic text data, provided in the initial FortiGate request to the web server, contains the username, password
paramaters:

magic=00050c839182f095&username=<username>&password=<password>

Vendor-specific attributes

Vendor specific attributes (VSA) are the method RADIUS servers and client companies use to extend the basic
functionality of RADIUS. Some major vendors, such as Microsoft, have published their VSAs, however many do
not.

In order to support vendor-specific attributes (VSA), the RADIUS server requires a dictionary to define which VSAs
to support. This dictionary is typically supplied by the client or server vendor.

The Fortinet RADIUS vendor ID is 12356.

The FortiGate unit RADIUS VSA dictionary is supplied by Fortinet and is available through the Fortinet
Knowledge Base (http://kb.forticare.com) or through Technical Support. Fortinet’s dictionary for FortiOS 4.0 and
up is configured this way:

##
Fortinet’s VSA’s
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#
VENDOR fortinet 12356
BEGIN-VENDOR fortinet
ATTRIBUTE Fortinet-Group-Name   1   string
ATTRIBUTE Fortinet-Client-IP-Address   2   ipaddr
ATTRIBUTE Fortinet-Vdom-Name   3   string
ATTRIBUTE Fortinet-Client-IPv6-Address   4   octets
ATTRIBUTE Fortinet-Interface-Name   5   string
ATTRIBUTE Fortinet-Access-Profile   6   string
#
# Integer Translations
#
END-VENDOR Fortinet

Note that using the Fortinet-Vdom-Name, users can be tied to a specific VDOM on the FortiGate unit. See the
documentation provided with your RADIUS server for configuration details.

RADIUS CoA support

As of FortiOS 5.4, RADIUS Change of Authorization (CoA) settings can be configured via the CLI. CoA is a
common feature in user authentication that provides the ability to change authentication attributes for sessions
even after they have authenticated.

User, user group, and captive portal authentication supports RADIUSCoA, when the back end authentication
server is RADIUS. The main use case of this feature is with external captive portal, where it can be used to
disconnect hotspot users when their time, credit, or bandwidth has been used up.

The commands below control CoA settings.

1. Set the name of the FortiAP connected to the FortiGate as a location identifier.
config system global

set alias <name>

2. Set URL of external authentication logout server.
config vdom

edit root
config wireless-controller vap

edit <example>
set security captive-portal
set external-logout

3. Set URL of external authentication logout server
config vdom

edit root
config system interface

edit <example>
set security captive-portal
set security-external-logout

4. Set class name(s) included in an Access-Accept message.
config vdom

edit root
config user radius

edit accounting
set class <"A1=aaa" "B2=bbb" "C3=ccc">
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Role Based Access Control

In Role Based Access Control (RBAC), network administrators and users have varying levels of access to network
resources based on their role, and that role’s requirement for access specific resources. For example, a junior
accountant does not require access to the sales presentations, or network user account information.

There are three main parts to RBAC: role assignment, role authorization, and transaction authorization. Role
assignment is accomplished when someone in an organization is assigned a specific role by a manager or HR.
Role authorization is accomplished when a network administrator creates that user’s RADIUS account and
assigns them to the required groups for that role. Transaction authorization occurs when that user logs on and
authenticates before performing a task.

RBAC is enforced when FortiOS network users are remotely authenticated via a RADIUS server. For users to
authenticate, a security policy must be matched. That policy only matches a specific group of users. If VDOMs
are enabled, the matched group will be limited to a specific VDOM. Using this method network administrators can
separate users into groups that match resources, protocols, or VDOMs. It is even possible to limit users to
specific FortiGate units if the RADIUS servers serve multiple FortiOS units.

For more information on security policies, see Authentication in security policies on page 445.

RADIUS password encoding

Certain RADIUS servers use ISO-8859-1 password encoding instead of others such as UTF-8. In these instances,
the server will fail to authenticate the user, if the user's password is using UTF-8.

CLI syntax

config user radius
edit <example>

set password-encoding <auto | ISO-8859-1>
end

This option will be skipped if the auth-type is neither auto nor pap.

RADIUS accounting start message options

Administrators can now choose between sending accounting start messages to all configured accounting servers,
or just the one server that was previously connected.

Syntax

config user radius
edit <name>

set acct-interim-interval <seconds>
set acct-all-servers {enable | disable}

next
end

Configuring the FortiGate unit to use a RADIUS server

The information you need to configure the FortiGate unit to use a RADIUS server includes

l the RADIUS server’s domain name or IP address
l the RADIUS server’s shared secret key.
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You can optionally specify the NAS IP or Called Station ID. When configuring the FortiGate to use a RADIUS
server, the FortiGate is a Network Access Server (NAS). If the FortiGate interface has multiple IP addresses, or
you want the RADIUS requests to come from a different address you can specify it here. Called Station ID applies
to carrier networks. However, if the NAS IP is not included in the RADIUS configuration, the IP of the FortiGate
unit interface that communicates with the RADIUS server is used instead.

Amaximum of 10 remote RADIUS servers can be configured on the FortiGate unit. One or more servers must be
configured on FortiGate before remote users can be configured. To configure remote users, see Local and
remote users on page 416.

On the FortiGate unit, the default port for RADIUS traffic is 1812. Some RADIUS servers use port 1645. If this is
the case with your server, you can either:

l Re-configure the RADIUS server to use port 1812. See your RADIUS server documentation for more information on
this procedure.

or

l Change the FortiGate unit default RADIUS port to 1645 using the CLI:

config system global
set radius-port 1645

end

One wildcard admin account can be added to the FortiGate unit when using RADIUS authentication. This uses
the wildcard character to allow multiple admin accounts on RADIUS to use a single account on the FortiGate unit.
See Example — wildcard admin accounts - CLI on page 402.

To configure the FortiGate unit for RADIUS authentication - web-based manager:

1. Go to User & Device > RADIUS Servers and select Create New.
2. Enter the following information and select OK.

Name A name to identify the RADIUS server on the FortiGate unit.

Primary Server Name/IP Enter the domain name (such as fgt.exmaple.com) or the IP address of the
RADIUS server.

Primary Server Secret Enter the server secret key, such as radiusSecret. This can be a maximum
of 16 characters long.

This must match the secret on the RADIUS primary server.

Secondary Server Name/IP Optionally enter the domain name (such as fgt.exmaple.com) or the IP
address of the secondary RADIUS server.

Secondary Server Secret Optionally, enter the secondary server secret key, such as radiusSecret2.
This can be a maximum of 16 characters long.

This must match the secret on the RADIUS secondary server.

Authentication Scheme If you know the RADIUS server uses a specific authentication protocol,
select it from the list. Otherwise select Use Default Authentication
Scheme. The Default option will usually work.
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NAS IP/ Called
Station ID

Enter the IP address to be used as an attribute in RADIUS access requests.

NAS-IP-Address is RADIUS setting or IP address of FortiGate interface
used to talk to RADIUS server, if not configured.

Called Station ID is same value as NAS-IP Address but in text format.

Include in every User
Group

When enabled this RADIUS server will automatically be included in all user
groups. This is useful if all users will be authenticating with the remote
RADIUS server.

For MAC OS and iOS devices to authenticate, you must use MS-CHAP-v2
authentication. In the CLI, the command is set auth-type ms_chap_v2.

3. Select OK.

To configure the FortiGate unit for RADIUS authentication - CLI example:

config user radius
edit ourRADIUS

set auth-type auto
set server 10.11.102.100
set secret radiusSecret

end

For more information about RADIUS server options, refer to the FortiGate CLI Reference.

Troubleshooting RADIUS

To test the connection to the RADIUS server use the following command:

diagnose test authserver radius-direct <server_name or IP> <port number> <secret>

For the port number, enter -1 to use the default port. Otherwise enter the port number to check.

Test results show RADIUS server reachability, NAS client rejection, and invalid User/Password. Test also shows
RADIUS Attributes returned from the RADIUS server.

LDAP servers
Lightweight Directory Access Protocol (LDAP) is an Internet protocol used to maintain authentication data that
may include departments, people, groups of people, passwords, email addresses, and printers. LDAP consists of
a data-representation scheme, a set of defined operations, and a request/response network.

The scale of LDAP servers range from big public servers such as BigFoot and Infospace, to large organizational
servers at universities and corporations, to small LDAP servers for workgroups that may be using OpenLDAP.
This document focuses on the institutional and workgroup applications of LDAP.

This section includes:
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l Components and topology
l LDAP directory organization
l Configuring the FortiGate unit to use an LDAP server
l Example — wildcard admin accounts - CLI
l Example of LDAP to allow Dial-in through member-attribute - CLI
l Troubleshooting LDAP

Components and topology

LDAP organization starts with directories. A directory is a set of objects with similar attributes organized in a
logical and hierarchical way. Generally, an LDAP directory tree reflects geographic and organizational
boundaries, with the Domain name system (DNS) names to structure the top level of the hierarchy. The common
name identifier for most LDAP servers is cn, however some servers use other common name identifiers such as
uid.

When LDAP is configured and a user is required to authenticate the general steps are:

1. The FortiGate unit contacts the LDAP server for authentication.
2. To authenticate with the FortiGate unit, the user enters a username and password.
3. The FortiGate unit sends this username and password to the LDAP server.
4. If the LDAP server can authenticate the user, the user is successfully authenticated with the FortiGate unit.
5. If the LDAP server cannot authenticate the user, the connection is refused by the FortiGate unit.

Binding

Binding is the step where the LDAP server authenticates the user. If the user is successfully authenticated,
binding allows the user access to the LDAP server based on that user’s permissions.

The FortiGate unit can be configured to use one of three types of binding:

l anonymous - bind using anonymous user search
l regular - bind using username/password and then search
l simple - bind using a simple password authentication without a search

You can use simple authentication if the user records all fall under one domain name (dn). If the users are under
more than one dn, use the anonymous or regular type, which can search the entire LDAP database for the
required username.

If your LDAP server requires authentication to perform searches, use the regular type and provide values for
username and password.

Supported versions

The FortiGate unit supports LDAP protocol functionality defined in RFC 2251: Lightweight Directory Access
Protocol v3, for looking up and validating user names and passwords. FortiGate LDAP supports all LDAP servers
compliant with LDAP v3, including FortiAuthenticator. In addition, FortiGate LDAP supports LDAP over SSL/TLS,
which can be configured only in the CLI.

FortiGate LDAP does not support proprietary functionality, such as notification of password expiration, which is
available from some LDAP servers. FortiGate LDAP does not supply information to the user about why
authentication failed.
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LDAP user authentication is supported for PPTP, L2TP, IPsec VPN, and firewall
authentication.

However, with PPTP, L2TP, and IPsec VPN, PAP (Packet Authentication Protocol) is
supported, while CHAP (Challenge Handshake Authentication Protocol) is not.

LDAP directory organization

To configure your FortiGate unit to work with an LDAP server, you need to understand the organization of the
information on the server.

The top of the hierarchy is the organization itself. Usually this is defined as Domain Component (DC), a DNS
domain. If the name contains a dot, such as example.com, it is written as two parts separated by a comma:
dc=example,dc=com.

In this example, Common Name (CN) identifiers reside at the Organization Unit (OU) level, just below DC. The
Distinguished Name (DN) is ou=People,dc=example,dc=com.

LDAP object hierarchy

In addition to the DN, the FortiGate unit needs an identifier for the individual person. Although the FortiGate unit
GUI calls this the Common Name (CN), the identifier you use is not necessarily CN. On some servers, CN is the
full name of a person. It might be more convenient to use the same identifier used on the local computer network.
In this example, User ID (UID) is used.

Locating your identifier in the hierarchy

You need to determine the levels of the hierarchy from the top to the level that contain the identifier you want to
use. This defines the DN that the FortiGate unit uses to search the LDAP database. Frequently used
distinguished name elements include:

l uid (user identification)
l pw (password)
l cn (common name)
l ou (organizational unit)
l o (organization)
l c (country)
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One way to test this is with a text-based LDAP client program. For example, OpenLDAP includes a client,
ldapsearch, that you can use for this purpose.

Enter the following at the command line:

ldapsearch -x '(objectclass=*)'

The output is lengthy, but the information you need is in the first few lines:

version: 2
#
# filter: (objectclass=*)
# requesting: ALL

dn: dc=example,dc=com
dc: example
objectClass: top
objectClass: domain

dn: ou=People,dc=example,dc=com
ou: People
objectClass: top
objectClass: organizationalUnit
...
dn: uid=tbrown,ou=People,dc=example,dc=com
uid: tbrown
cn: Tom Brown

In the output above, you can see tbrown (uid) and Tom Brown(cn). Also note the dn is ou=People,
dc=example, dc=com.

Configuring the FortiGate unit to use an LDAP server

After you determine the common name and distinguished name identifiers and the domain name or IP address of
the LDAP server, you can configure the server on the FortiGate unit. The maximum number of remote LDAP
servers that can be configured is 10.

One or more servers must be configured on FortiGate before remote users can be configured. To configure
remote users, see Local and remote users on page 416.

To configure the FortiGate unit for LDAP authentication - web-based manager:

1. Go to User & Device > LDAP Servers and select Create New.
2. Enter a Name for the LDAP server.
3. In Server Name/IP enter the server’s FQDN or IP address.
4. If necessary, change the Server Port number. The default is port 389.
5. Enter the Common Name Identifier (20 characters maximum).

cn is the default, and is used by most LDAP servers.
6. In the Distinguished Name field, enter the base distinguished name for the server using the correct X.500 or

LDAP format.
The FortiGate unit passes this distinguished name unchanged to the server. The maximum number of characters
is 512.
If you don’t know the distinguished name, leave the field blank and select the Query icon to the right of the field.
See Using the Query icon on page 401.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

399



Authentication servers

7. In the Distinguished Name field, enter the base distinguished name for the server using the correct X.500 or
LDAP format.
The FortiGate unit passes this distinguished name unchanged to the server. The maximum number of characters
is 512.
If you don’t know the distinguished name, leave the field blank and select the Query icon to the right of the field.
See Using the Query icon on page 401.

8. In Bind Type, select Regular.
9. In User DN, enter the LDAP administrator’s distinguished name.
10. In Password, enter the LDAP administrator’s password.
11. Select OK.

To verify your Distinguished Name field is correct, you can select the Test button. If
your DN field entry is valid, you will see the part of the LDAP database it defines. If
your DN field entry is not valid, it will display an error message and return no
information.

For detailed information about configuration options for LDAP servers, see the Online Help on your FortiGate unit
or the FortiGate CLI Reference.

To configure the FortiGate unit for LDAP authentication - CLI example:

config user ldap
edit ourLDAPsrv

set server 10.11.101.160
set cnid cn
set dn cn=users,dc=office,dc=example,dc=com
set type regular
set username cn=administrator,cn=users,dc=office,dc=example,dc=com
set password w5AiGVMLkgyPQ
set password-expiry-warning enable
set password-renewal enable

end

password-expiry-warning and password-renewal

In SSLVPN, when an LDAP user is connecting to the LDAP server it is possible for them to receive any pending
password expiry or renewal warnings. When the password renewal or expiry warning exists, SSLVPN users will
see a prompt allowing them to change their password.

password-expiry-warning allows FortiOS to detect from the OpenLDAP server when a password is
expiring or has expired using server controls or error codes. Please note that this is currently not supported for
Windows AD LDAP.

password-renewal allows FortiOS to perform the online LDAP password renewal operations the LDAP server
expects.

On an OpenLDAP server, when a user attempts to logon with an expired password they are allowed to logon but
only to change their password.

When changing passwords on a Windows AD system, the connection must be SSL-protected.
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UPN processing method and filter name

The following CLI commands available under config user ldap allow you to keep or strip the domain string
of UPN in the token as well as the search name for this kind of UPN.

CLI syntax:

config user ldap
set account-key-processing
set account-key-name

end

Using the Query icon

The LDAPDistinguished Name Query list displays the LDAP directory tree for the LDAP server connected to the
FortiGate unit. This helps you to determine the appropriate entry for the DN field. To see the distinguished name
associated with the Common Name identifier, select the Expand icon next to the CN identifier. Select the DN
from the list. The DN you select is displayed in the Distinguished Name field. Select OK and the Distinguished
Name you selected will be saved in the Distinguished Name field of the LDAP Server configuration.

To see the users within the LDAP Server user group for the selected Distinguished Name, expand the
Distinguished Name in the LDAPDistinguished Name Query tree.

LDAP server Distinguished Name Query tree
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Non-blocking LDAP authentication

To support non-blocking LDAP authentication, fnbamd will create its own event-driven connection with LDAP
servers over LDAP/LDAPS/STARTTLS, make it non-blocking, do CRL checking if necessary, and compose all
LDAP requests using liblber (including bind, unbind, search, password renewal, password query, send request
and receive response, and parse response). The whole process is done in one connection.

This doesn't change any openLDAP implementation but moves some data structure definitions and API
definitions from some internal header files to public header files.

Example — wildcard admin accounts - CLI

Awildcard admin account is an administrator account with the wildcard option enabled. This option allows
multiple different remote administration accounts to match one local administration account, avoiding the need
to set up individual admin accounts on the FortiGate unit. Instead multiple LDAP admin accounts will all be able
to use one FortiGate admin account.

The initial benefit of wildcard admin accounts is fast configuration of the FortiGate unit’s administration account
to work with your LDAP network. The many to one ratio saves on effort, and potential errors.

The ongoing benefit is that as long as the users on the LDAP system belong to that group, and the test admin
user settings don’t change on the FortiGate unit, no other work is required. This point is important as it can help
avoid system updates or changes that would otherwise require changes to the LDAP administrator account
configuration. Even if a user is added to or removed from the LDAP group, no changes are required on the
FortiGate unit.

Two potential issues with wildcard admin accounts are that multiple users may be logged on to the same account
at the same time. This becomes an issue if they are changing the same information at the same time. The other
potential issue is that security is reduced because multiple people have login access for the same account. If
each user was assigned their own account, a hijacking of one account would not affect the other users.

Note that wildcard admin configuration also applies to RADIUS. When configuring for RADIUS, configure the
RADIUS server, and RADIUS user group instead of LDAP. When using web-based management, wildcard admin
is the only type of remote administrator account that does not require you to enter a password on account
creation. That password is normally used when the remote authentication server is unavailable during
authentication.

In this example, default values are used where possible. If a specific value is not mentioned, it is set to its default
value.

Configuring the LDAP server

The important parts of this configuration are the username and group lines. The username is the domain
administrator account. The group binding allows only the group with the name GRP to access.

The dn used here is as an example only. On your network use your own domain name.

To configure LDAP server - CLI:

config user ldap
edit "ldap_server"

set server "192.168.201.3"
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set cnid "sAMAccountName"
set dn "DC=example,DC=com,DC=au"
set type regular
set username "CN=Administrator,CN=Users,DC=example,DC=COM”
set password *
set group-member-check group-object
set group-object-filter (&

(objectcategory=group)member="CN=GRP,OU=training,DC=example,DC=COM"))
next

end

To configure the user group and add the LDAP server - CLI:

config user group
edit "ldap_grp"

set member "ldap"
config match

edit 1
set server-name "ldap_server"
set group-name "CN=GRP,OU=training,DC=example,DC=COM"

next
end

next
end

Configuring the admin account

The wildcard part of this example is only available in the CLI for admin configuration. When enabled, this allows
all LDAP group members to login to the FortiGate unit without the need to create a separate admin account for
each user. In effect the members of that group will each be able to login as “test”.

To configure the admin account - CLI:

config system admin
edit "test"

set remote-auth enable
set accprofile "super_admin"
set wildcard enable
set remote-group "ldap_grp"

next
end

For troubleshooting, test that the admin account is operational, and see Troubleshooting LDAP on page 404.

Example of LDAP to allow Dial-in through member-attribute - CLI

In this example, users defined in MicroSoft Windows Active Directory (AD) are allowed to setup a VPN connection
simply based on an attribute that is set to TRUE, instead of based on being part of a specific group.

In AD, the “Allow Dial-In” property is activated in the user properties, and this sets the msNPAllowDialin
attribute to “TRUE”.

This same procedure can be used for other member attributes, as your system requires.
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Configuring LDAP member-attribute settings

To accomplish this with a FortiGate unit, the member attribute must be set. Setting member attributes can only
be accomplished through the CLI using the member-attr keyword - the option is not available through the web-
based manager.

Before configuring the FortiGate unit, the AD server must be configured and have the msNPAllowDialin
attribute set to “TRUE” for the users in question. If not, those users will not be able to properly authenticate.

The dn used here is as an example only. On your network use your own domain name.

To configure user LDAP member-attribute settings - CLI:

config user ldap
edit "ldap_server"

set server "192.168.201.3"
set cnid "sAMAccountName"
set dn "DC=fortinet,DC=com,DC=au"
set type regular
set username "fortigate@example.com"
set password ******
set member-attr "msNPAllowDialin"

next
end

Configuring LDAP group settings

A user group that will use LDAPmust be configured. This example adds the member ldap to the group which is
the LDAP server name that was configured earlier.

To configure LDAP group settings - CLI:

config user group
edit "ldap_grp"

set member "ldap"
config match
edit 1

set server-name "ldap"
set group-name "TRUE"

next
end

end

Once these settings are in place, users can authenticate.

Troubleshooting LDAP

The examples in this section use the values from the previous example.

LDAP user test

A quick way to see if the LDAP configuration is correct is to run a diagnose CLI command with LDAP user
information. The following command tests with a user called netAdmin and a password of fortinet. If the
configuration is correct the test will be successful.

FGT# diag test authserver ldap ldap_server netAdmin fortinet
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'ldap_server' is not a valid ldap server name— an LDAP server by that name has not been
configured on the FortiGate unit, check your spelling.

authenticate 'netAdmin' against 'ldap_server' failed!— the user netAdmin does not
exist on ldap_server, check your spelling of both the user and sever and ensure the user has been configured
on the FortiGate unit.

LDAP authentication debugging

For a more in-depth test, you can use a diag debug command. The sample output from a showsmore
information about the authentication process that may prove useful if there are any problems.

Ensure the “Allow Dial-in” attribute is still set to “TRUE” and run the following CLI command. fnbamd is the
Fortinet non-blocking authentication daemon.

FGT# diag debug enable
FGT# diag debug reset
FGT# diag debug application fnbamd –1
FGT# diag debug enable

The output will look similar to:

get_member_of_groups-Get the memberOf groups.
get_member_of_groups- attr='msNPAllowDialin', found 1 values
get_member_of_groups-val[0]='TRUE'
fnbamd_ldap_get_result-Auth accepted
fnbamd_ldap_get_result-Going to DONE state res=0
fnbamd_auth_poll_ldap-Result for ldap svr 192.168.201.3 is SUCCESS
fnbamd_auth_poll_ldap-Passed group matching

If the “Allow Dial-in” attribute is not set but it is expected, the last line of the above output will instead be:

fnbamd_auth_poll_ldap-Failed group matching

TACACS+ servers
When users connect to their corporate network remotely, they do so through a remote access server. As remote
access technology has evolved, the need for security when accessing networks has become increasingly
important. This need can be filled using a Terminal Access Controller Access-Control System (TACACS+) server.

TACACS+ is a remote authentication protocol that provides access control for routers, network access servers,
and other networked computing devices via one or more centralized servers. TACACS+ allows a client to accept a
username and password and send a query to a TACACS+ authentication server. The server host determines
whether to accept or deny the request and sends a response back that allows or denies the user access to the
network.

TACACS+ offers fully encrypted packet bodies, and supports both IP and AppleTalk protocols. TACACS+ uses
TCP port 49, which is seen as more reliable than RADIUS’s UDP protocol.

There are several different authentication protocols that TACACS+ can use during the authentication process:
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Authentication protocols

Protocol Definition

ASCII Machine-independent technique that uses representations of English characters.
Requires user to type a username and password that are sent in clear text
(unencrypted) and matched with an entry in the user database stored in ASCII format.

PAP Password Authentication Protocol (PAP) Used to authenticate PPP connections.
Transmits passwords and other user information in clear text.

CHAP Challenge-Handshake Authentication Protocol (CHAP) Provides the same functionality
as PAP, but is more secure as it does not send the password and other user
information over the network to the security server.

MS-CHAP MicroSoft Challenge-Handshake Authentication Protocol v1 (MSCHAP) Microsoft-
specific version of CHAP.

default The default protocol configuration, Auto, uses PAP, MS-CHAP, and CHAP, in that
order.

TACACS+ attribute value pairs

FortiGate sends the following proprietary TACACS+ attributes to the TACACS+ server during authorization
requests:

l service=<name>: The user must be authorized to access the service specified.
l memberof: The group that the user belongs to.
l admin_prof: The administrator profile (admin access only).

Note that only thememberof and admin_prof attributes are also parsed in authentication replies.

Configuring a TACACS+ server on the FortiGate unit

Amaximum of 10 remote TACACS+ servers can be configured for authentication.

One or more servers must be configured on FortiGate before remote users can be configured. To configure
remote users, see Local and remote users on page 416.

The TACACS+ page in the web-based manager (User & Device >
TACACS+ Servers) is not available until a TACACS+ server has been configured in
the CLI. For more information see the CLI Reference.

To configure the FortiGate unit for TACACS+ authentication - web-based manager:

1. Go to User & Device > TACACS+ Servers and select Create New.
2. Enter the following information, and select OK.

Name Enter the name of the TACACS+ server.
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Server Name/IP Enter the server domain name or IP address of the TACACS+ server.

Server Key Enter the key to access the TACACS+ server.

Authentication Type Select the authentication type to use for the TACACS+ server. Auto tries
PAP, MSCHAP, and CHAP (in that order).

To configure the FortiGate unit for TACACS+ authentication - CLI:

config user tacacs+
edit "TACACS-SERVER"

set server [IP_ADDRESS]
set key [PASSWORD]
set authen-type ascii

next
end
config user group

edit "TACACS-GROUP"
set group-type firewall
set member "TACACS-SERVER"

next
end
config system admin

edit TACACS-USER
set remote-auth enable
set accprofile "super_admin"
set vdom "root"
set wildcard enable
set remote-group "TACACS-GROUP"

next
end

IPv6 TACACS+ server IP address

IPv6 address support is available for TACACS+ servers.

Syntax

config user tacacs+
edit <name>

set server <ipv6 address>
set source-ipv6 <ipv6 address>

next
end

POP3 servers
FortiOS can authenticate users who have accounts on POP3 or POP3s email servers. POP3 authentication can
be configured only in the CLI.

To configure the FortiGate unit for POP3 authentication:

config user pop3
edit pop3_server1

set server pop3.fortinet.com
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set secure starttls
set port 110

end

To configure a POP3 user group:

config user group
edit pop3_grp

set member pop3_server1
end

A user group can list up to six POP3 servers as members.

SSO servers
Novell and Microsoft Windows networks provide user authentication based on directory services: eDirectory for
Novell, Active Directory for Windows. Users can log on at any computer in the domain and have access to
resources as defined in their user account. The Fortinet Single Sign On (FSSO) agent enables FortiGate units to
authenticate these network users for security policy or VPN access without asking them again for their username
and password.

When a user logs in to the Windows or Novell domain, the FSSO agent sends to the FortiGate unit the user’s IP
address and the names of the user groups to which the user belongs. The FortiGate unit uses this information to
maintain a copy of the domain controller user group database. Because the domain controller authenticates
users, the FortiGate unit does not perform authentication. It recognizes group members by their IP address.

In the FortiOS FSSO configuration, you specify the server where the FSSO Collector agent is installed. The
Collector agent retrieves the names of the Novell or Active Directory user groups from the domain controllers on
the domains, and then the FortiGate unit gets them from the Collector agent. You cannot use these groups
directly. You must define FSSO type user groups on your FortiGate unit and then add the Novell or Active
Directory user groups to them. The FSSO user groups that you created are used in security policies and VPN
configurations to provide access to different services and resources.

FortiAuthenticator servers can replace the Collector agent when FSSO is using polling mode. The benefits of this
is that FortiAuthenticator is a stand-alone server that has the necessary FSSO software pre-installed. For more
information, see the FortiAuthenticator Administration Guide.

Single Sign-on Agent configuration settings

The following are SSO configuration settings in User & Device > Single Sign-On.

SSO Server List

Lists all the collector agents’ lists that you have configured. On this page, you can create, edit or delete FSSO
agents. There are different types of FSSO agents, each with its own settings.

You can create a redundant configuration on your unit if you install a collector agent on
two or more domain controllers. If the current (or first) collector agent fails, the Fortinet
unit switches to the next one in its list of up to five collector agents.
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Create New Creates a new agent. When you select Create New, you are automatically redirected
to the New page.

Edit Modifies the settings for the selected SSO server.

To remove multiple entries from the list, for each servers you want removed, select the
check box and then select Delete.

To remove all agents from the list, on the FSSO Agent page, select the check box at
the top of the check box column and then select Delete.

Delete Removes an agent from the list on the page.

Settings when Type is Poll Active Directory Server

Server IP/Name The IP address of the domain controller (DC).

User The user ID used to access the domain controller.

Password Enter the password for the account used to access the DC.

LDAP Server Select the check box and select an LDAP server to access the Directory Service.

Enable Polling Enable to allow the FortiGate unit to poll this DC.

Users/Groups A list of user and user group names retrieved from the DC.

Settings when Type is Fortinet Single Sign On Agent

Name Enter a name for the SSO server.

Primary Agent
IP/Name

Secondary Agent
IP/Name

Enter the IP address or name of the Directory Service server where this SSO agent is
installed. The maximum number of characters is 63.

Password Enter the password for the collector agent. This is required only if you configured your
Fortinet Single Sign On Agent collector agent to require authenticated access.

LDAP Server Select the check box and select an LDAP server to access the Directory Service.

More FSSO
agents

Select to add up to three additional SSO agents.

Users/Groups A list of user and user group names retrieved from the server.
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Settings when Type is RADIUS Single Sign On Agent

Use RADIUS
Shared Secret

Enable

Shared Secret Enter the RADIUS server shared secret.

Send RADIUS
Responses

Enable.

RSA ACE (SecurID) servers
SecurID is a two-factor system that uses one-time password (OTP) authentication. It is produced by the company
RSA. This system includes portable tokens carried by users, an RSA ACE/Server, and an Agent Host. In our
configuration, the FortiGate unit is the Agent Host.

Components

When using SecurID, users carry a small device or “token” that generates and displays a pseudo-random
password. According to RSA, each SecurID authenticator token has a unique 64-bit symmetric key that is
combined with a powerful algorithm to generate a new code every 60 seconds. The token is time-synchronized
with the SecurID RSA ACE/Server.

The RSA ACE/Server is the management component of the SecurID system. It stores and validates the
information about the SecurID tokens allowed on your network. Alternately the server could be an RSA SecurID
130 Appliance.

The Agent Host is the server on your network, in this case it is the FortiGate unit, that intercepts user logon
attempts. The Agent Host gathers the user ID and password entered from their SecurID token, and sends that
information to the RSA ACE/Server to be validated. If valid, a reply comes back indicating it is a valid logon and
the FortiGate unit allows the user access to the network resources specified in the associated security policy.

Configuring the SecurID system

To use SecurID with a FortiGate unit, you need:

l to configure the RSA server and the RADIUS server to work with each other (see RSA server documentation)
l to configure the RSA SecurID 130 Appliance

or
l to configure the FortiGate unit as an Agent Host on the RSA ACE/Server
l to configure the FortiGate unit to use the RADIUS server
l to create a SecurID user group
l to configure a security policy with SecurID authentication

The following instructions are based on RSA ACE/Server version 5.1, or RSA SecurID 130 Appliance, and assume
that you have successfully completed all the external RSA and RADIUS server configuration steps listed above.

For this example, the RSA server is on the internal network, with an IP address of 192.128.100.100. The
FortiGate unit internal interface address is 192.168.100.3, RADIUS shared secret is fortinet123, RADIUS server
is at IP address 192.168.100.102.
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To configure the RSA SecurID 130 Appliance

1. Go to the IMSConsole for SecurID and logon.
2. Go to RADIUS > RADIUS Clients, and select Add New.
3. Enter the following information to configure your FortiGate as a SecurID Client, and select Save.

RADIUS Client Basics

Client Name FortiGate

Associated RSA Agent FortiGate

RADIUS Client Settings

IP Address 192.168.100.3

The IP address of the FortiGate unit internal interface.

Make / Model Select Standard Radius

Shared Secret fortinet123

The RADIUS shared secret.

Accounting Leave unselected

Client Status Leave unselected

To configure the FortiGate unit as an Agent Host on the RSA ACE/Server

1. On the RSA ACE/Server computer, go to Start > Programs > RSA ACE/Server, and then Database
Administration - Host Mode.

2. On the Agent Hostmenu, select Add Agent Host.
3. Enter and save the following information.

Name FortiGate

Network Address 192.168.100.3

The IP address of the FortiGate unit.

Secondary Nodes Optionally enter other IP addresses that resolve to the FortiGate unit.

If needed, refer to the RSA ACE/Server documentation for more information.

To configure the FortiGate unit to use the RADIUS server

1. Go to User & Device > RADIUS Servers and select Create New.
2. Enter the following information, and select OK.
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Name RSA

Primary Server IP/Name 192.168.100.102
Optionally select Test to ensure the IP address is correct and the FortiGate
can contact the RADIUS server.

Primary Server Secret fortinet123

Authentication Scheme Select Use Default Authentication Scheme.

To create a SecurID user group

1. Go to User & Device > User Groups, and select Create New.
2. Enter the following information.

Name RSA_group

Type Firewall

3. In Remote Groups, select Add, then select the RSA server.
4. Select OK.

To create a SecurID user:

1. Go to User & Device > User Definition, and select Create New.
2. Use the wizard to enter the following information, and then select Create.

User Type Remote RADIUSUser

User Name wloman

RADIUS Server RSA

Contact Info (optional) Enter Email or SMS information

User Group RSA_group

To test this configuration, on your FortiGate unit use the CLI command:

diagnose test authserver radius RSA auto wloman 111111111

The series of 1s is the one time password that your RSA SecurID token generates and you enter.

Using the SecurID user group for authentication

You can use the SecurID user group in several FortiOS features that authenticate by user group including

l Security policy
l IPsec VPN XAuth
l PPTP VPN
l SSL VPN
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The following sections assume the SecurID user group is called securIDgrp and has already been configured.
Unless otherwise states, default values are used.

Security policy

To use SecurID in a security policy, you must include the SecurID user group in a security policy. This procedure
will create a security policy that allows HTTP, FTP, and POP3 traffic from the internal interface to wan1. If
these interfaces are not available on your FortiGate unit, substitute other similar interfaces.

To configure a security policy with SecurID authentication

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Enter:

Incoming Interface internal

Source Address all

Source User(s) securIDgrp

Outgoing Interface wan1

Destination Address all

Schedule always

Services HTTP, FTP, POP3

Action ACCEPT

NAT On

Shared Shaper On, if you want to either limit traffic or guarantee minimum bandwidth for
traffic that uses the SecurID security policy. Use the default shaper
guarantee-100kbps.

Log Allowed Traffic On, if you want to generate usage reports on traffic authenticated with this
policy.

4. Select OK.
The SecurID security policy is configured.

For more detail on configuring security policies, see the FortiOS Handbook FortiGate Fundamentals guide.

IPsec VPN XAuth

Extended Authentication (XAuth) increases security by requiring user authentication in addition to the preshared
key.

When creating an IPsec VPN using the wizard, under VPN > IPsec Wizard, select the SecurIDUser Group on
the Authentication page. Members of the SecurID group are required to enter their SecureID code to
authenticate.

For more on XAuth, see Configuring XAuth authentication on page 462
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PPTP VPN

PPTP VPN is configured in the CLI. In the PPTP configuration (config vpn pptp), set usrgrp to the
SecurID user group.

SSL VPN

You need to map the SecurID user group to the portal that will serve SecurID users and include the SecurID user
group in the Source User(s) field in the security policy.

To map the SecurID group to an SSL VPN portal:

1. Go to VPN > SSL-VPN Settings.
2. In Authentication/Portal Mapping, select Create New.
3. Enter

Users/Groups securIDgrp

Portal Choose the portal.

4. Select OK.
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FortiGate authentication controls system access by user group. By assigning individual users to the appropriate
user groups you can control each user’s access to network resources. The members of user groups are user
accounts, of which there are several types. Local users and peer users are defined on the FortiGate unit. User
accounts can also be defined on remote authentication servers.

This section describes how to configure local users and peer users and then how to configure user groups. For
information about configuration of authentication servers see Authentication servers on page 389.

This section contains the following topics:

l Users
l User groups

Users
A user is a user account consisting of username, password, and in some cases other information, configured on
the FortiGate unit or on an external authentication server. Users can access resources that require authentication
only if they are members of an allowed user group. There are several different types of user accounts with slightly
different methods of authentication:

User type Authentication

Local user The username and password must match a user account stored on the FortiGate unit.
Authentication by FortiGate security policy.

Remote user
The username must match a user account stored on the FortiGate unit and the
username and password must match a user account stored on the remote
authentication server. FortiOS supports LDAP, RADIUS, and TACACS+ servers.

Authentication
server user

A FortiGate user group can include user accounts or groups that exist on a remote
authentication server.

FSSO user

With Fortinet Single Sign On (FSSO), users on a Microsoft Windows or Novell network
can use their network authentication to access resources through the FortiGate unit.
Access is controlled through FSSO user groups which contain Windows or Novell user
groups as their members.

PKI or Peer user A Public Key Infrastructure (PKI) or peer user is a digital certificate holder who
authenticates using a client certificate. No password is required, unless two-factor
authentication is enabled.

IM Users
IM users are not authenticated. The FortiGate unit can allow or block each IM user
name from accessing the IM protocols. A global policy for each IM protocol governs
access to these protocols by unknown users.

Guest Users Guest user accounts are temporary. The account expires after a selected period of
time.
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This section includes:

l Local and remote users
l PKI or peer users
l Two-factor authentication
l FortiToken
l Monitoring users

Local and remote users

Local and remote users are defined on the FortiGate unit in User & Device > User Definition.

Create New Creates a new user account. When you select Create New, you are automatically
redirected to the User Creation Wizard.

Edit User Modifies a user’s account settings. When you select Edit, you are automatically
redirected to the Edit User page.

Delete Removes a user from the list. Removing the user name removes the authentication
configured for the user.

The Delete icon is not available if the user belongs to a user group.

To remove multiple local user accounts from within the list, on the User page, in each
of the rows of user accounts you want removed, select the check box and then select
Delete.

To remove all local user accounts from the list, on the User page, select the check box
in the check box column and then select Delete.

User Name The user name. For a remote user, this username must be identical to the username
on the authentication server.

Type Local indicates a local user authenticated on the FortiGate unit. For remote users, the
type of authentication server is shown: LDAP, RADIUS, or TACACS+.

Two-factor
Authentication Indicates whether two-factor authentication is configured for the user.

Ref. Displays the number of times this object is referenced by other objects. Select the
number to open the Object Usage window and view the list of referring objects. The
list is grouped into expandable categories, such as Firewall Policy. Numbers of objects
are shown in parentheses.

To view more information about the referring object, use the icons:
l View the list page for these objects – available for object categories. Goes

to the page where the object is listed. For example, if the category is User
Groups, opens User Groups list.

l Edit this object – opens the object for editing.
l View the details for this object – displays current settings for the object.
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To create a local or remote user account - web-based manager:

1. Go to User & Device > User Definition and select Create New.
2. On the Choose User Type page select:

Local User Select to authenticate this user using a password stored on the FortiGate
unit.

Remote RADIUS User
Remote TACACS+ User
Remote LDAP User

To authenticate this user using a password stored on an authentication
server, select the type of server and then select the server from the list. You
can select only a server that has already been added to the FortiGate unit
configuration.

3. Select Next and provide user authentication information.
For a local user, enter the User Name and Password.
For a remote user, enter the User Name and the server name.

4. Select Next and enterContact Information.
If email or SMS is used for two-factor authentication, provide the email address or SMS cell number at which the
user will receive token password codes. If a custom SMS service is used, it must already be configured. See
FortiToken on page 422.

5. Select Next, then on the Provide Extra Info page enter

Two-factor Authentication Select to enable two-factor authentication. Then select the Token
(FortiToken or FortiToken Mobile) for this user account. See Associating
FortiTokens with accounts on page 425.

User Group Select the user groups to which this user belongs.

6. Select Create.

To create a local user - CLI example:

Locally authenticated user

config user local
edit user1

set type password
set passwd ljt_pj2gpepfdw

end

To create a remote user - CLI example:

config user local
edit user2

set type ldap
set ldap_server ourLDAPsrv

end

For a RADIUS or TACACS+ user, set type to radius or tacacs+, respectively.

To create a user with FortiToken Mobile two-factor authentication - CLI example:

config user local
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edit user5
set type password
set passwd ljt_pj2gpepfdw
set two_factor fortitoken
set fortitoken 182937197

end

Remote users are configured for FortiToken two-factor authentication similarly.

To create a user with SMS two-factor authentication using FortiGuard messaging Service - CLI example:

config user local
edit user6

set type password
set passwd 3ww_pjt68dw
set two_factor sms
set sms-server fortiguard
set sms-phone 1365984521

end

Removing users

Best practices dictate that when a user account is no longer in use, it should be deleted. Removing local and
remote users from FortiOS involve the same steps.

If the user account is referenced by any configuration objects, those references must be removed before the user
can be deleted. See Removing references to users on page 418.

To remove a user from the FortiOS configuration - web-based manager:

1. Go to User & Device > User Definition.
2. Select the check box of the user that you want to remove.
3. Select Delete.
4. Select OK.

To remove a user from the FortiOS configuration - CLI example:

config user local
delete user4444

end

Removing references to users

You cannot remove a user that belongs to a user group. Remove the user from the user group first, and then
delete the user.

To remove references to a user - web-based manager

1. Go to User & Device > User Definition.
2. If the number in the far right column for the selected user contains any number other than zero, select it.
3. Amore detailed list of object references to this user is displayed. Use its information to find and remove these

references to allow you to delete this user.
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PKI or peer users

A PKI, or peer user, is a digital certificate holder. A PKI user account on the FortiGate unit contains the
information required to determine which CA certificate to use to validate the user’s certificate. Peer users can be
included in firewall user groups or peer certificate groups used in IPsec VPNs. For more on certificates, see
Certificates overview on page 475.

To define a peer user you need:

l a peer username
l the text from the subject field of the user’s certificate, or the name of the CA certificate used to validate the user’s

certificate

Creating a peer user

The peer user can be configured only in the CLI.

To create a peer user for PKI authentication - CLI example:

config user peer
edit peer1

set subject peer1@mail.example.com
set ca CA_Cert_1

end

There are other configuration settings that can be added or modified for PKI authentication. For example, you
can configure the use of an LDAP server to check access rights for client certificates. For information about the
detailed PKI configuration settings, see the FortiGate CLI Reference.

Two-factor authentication

The standard logon requires a username and password. This is one factor authentication—your password is one
piece of information you need to know to gain access to the system.

Two factor authentication adds the requirement for another piece of information for your logon. Generally the two
factors are something you know (password) and something you have (certificate, token, etc.). This makes it
harder for a hacker to steal your logon information. For example if you have a FortiToken device, the hacker
would need to both use it and know your password to gain entry to your account.

Two-factor authentication is available on both user and admin accounts. But before you enable two-factor
authentication on an administrator account, you need to ensure you have a second administrator account
configured to guarantee administrator access to the FortiGate unit if you are unable to authenticate on the main
admin account for some reason.

Two-factor authentication does not work with explicit proxies.

The methods of two-factor authentication include:

l Certificate
l Email
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l SMS
l FortiToken

Certificate

You can increase security by requiring both certificate and password authentication for PKI users. Certificates are
installed on the user’s computer. Requiring a password also protects against unauthorized use of that computer.

Optionally peer users can enter the code from their FortiToken instead of the certificate.

To create a peer user with two-factor authentication - CLI example

config user peer
edit peer1

set subject E=peer1@mail.example.com
set ca CA_Cert_1
set two-factor enable
set passwd fdktguefheygfe

end

For more information on certificates, see Certificates overview on page 475.

Email

Two-factor email authentication sends a randomly generated six digit numeric code to the specified email
address. Enter that code when prompted at logon. This token code is valid for 60 seconds. If you enter this code
after that time,it will not be accepted.

A benefit is that you do not require mobile service to authenticate. However, a potential issue is if your email
server does not deliver the email before the 60 second life of the token expires.

The code will be generated and emailed at the time of logon, so you must have email access at that time to be
able to receive the code.

To configure an email provider - web-based manager:

1. Go to System > Advanced and enable Use Custom Eamil Server under Email Service.
2. Enter SMTP Server and Default Reply To address.
3. If applicable, enable Authentication and enter the SMTP User and Password to use.
4. Select a Security Mode, options are: None, SMTPS or STARTTLS.
5. Enter the Port number, the default is 25.
6. Select Apply.

To configure an email provider - CLI:

config system email-server
set server <server_domain-name>
set reply-to <Recipient_email_address>

end

To enable email two-factor authentication - web-based manager:

1. To modify an administrator account, go to System > Administrators. To modify a user account go to User
& Device > User Definition.
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2. Edit the user account.
3. Enable and enter the user’sEmail Address.
4. Select Enable Two-factor Authentication.
5. Select Email based two-factor authentication.
6. Select OK.

If Email based two-factor authentication option doesn't appear after selecting
Enable Two-factor Authentication, you need to enable it via the CLI as follows.

To enable email two-factor authentication - CLI:
config user local

edit <user_name>
set email-to <user_email>
set two-factor email

end

SMS

SMS two-factor authentication sends the token code in an SMS text message to the mobile device indicated
when this user attempts to logon. This token code is valid for 60 seconds. If you enter this code after that time, it
will not be accepted. Enter this code when prompted at logon to be authenticated.

SMS two-factor authentication has the benefit that you do not require email service before logging on. A potential
issue is if the mobile service provider does not send the SMS text message before the 60 second life of the token
expires.

FortiGuard Messaging Service include four SMSMessages at no cost. If you need more, you should acquire a
license through support.fortinet.com or via customer service.

If you do not use the FortiGuard Messaging Service, you need to configure an SMS service.

To configure an SMS service - CLI:

config system sms-server
edit <provider_name>

set mail-server <server_domain-name>
next

end

To configure SMS two-factor authentication - web-based manager:

1. To modify an:
l administrator account, go to System > Administrators, or
l user account go to User & Device > User Definition.

2. Edit the user account.
3. Select SMS and enter the Country Dial Code and Phone Number.
4. Select Enable Two-factor Authentication. and select the correct Token.
5. Select OK.
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If you have problems receiving the token codes via SMSmessaging, contact your mobile provider to ensure you
are using the correct phone number format to receive text messages and that your current mobile plan allows text
messages.

FortiToken

FortiToken is a disconnected one-time password (OTP) generator. It is a small physical device with a button that
when pressed displays a six digit authentication code. This code is entered with a user’s username and password
as two-factor authentication. The code displayed changes every 60 seconds, and when not in use the LCD screen
is blanked to extend the battery life.

There is also a mobile phone application, FortiToken Mobile, that performs much the same function.

FortiTokens have a small hole in one end. This is intended for a lanyard to be inserted so the device can be worn
around the neck, or easily stored with other electronic devices. Do not put the FortiToken on a key ring as the
metal ring and other metal objects can damage it. The FortiToken is an electronic device like a cell phone and
must be treated with similar care.

Any time information about the FortiToken is transmitted, it is encrypted. When the FortiGate unit receives the
code that matches the serial number for a particular FortiToken, it is delivered and stored encrypted. This is in
keeping with the Fortinet’s commitment to keeping your network highly secured.

FortiTokens can be added to user accounts that are local, IPsec VPN, SSL VPN, and even Administrators. See
Associating FortiTokens with accounts on page 425.

A FortiToken can be associated with only one account on one FortiGate unit.

If a user loses their FortiToken, it can be locked out using the FortiGate so it will not be used to falsely access the
network. Later if found, that FortiToken can be unlocked on the FortiGate to allow access once again. See
FortiToken maintenance on page 427.

There are three tasks to complete before FortiTokens can be used to authenticate accounts:

1. Adding FortiTokens to the FortiGate
2. Activating a FortiToken on the FortiGate
3. Associating FortiTokens with accounts
In addition, this section includes the following:

l FortiToken maintenance
l FortiToken Mobile Push

The FortiToken authentication process

The steps during FortiToken two-factor authentication are as follows.

1. User attempts to access a network resource.
2. FortiGate unit matches the traffic to an authentication security policy, and FortiGate unit prompts the user for

username and password.
3. User enters their username and password.
4. FortiGate unit verifies their information, and if valid prompts the user for the FortiToken code.
5. User gets the current code from their FortiToken device.
6. User enters current code at the prompt.
7. FortiGate unit verifies the FortiToken code, and if valid allows access to the network resources such as the

Internet.
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The following steps are needed only if the time on the FortiToken has drifted and needs to be re-synchronized with
the time on the FortiGate unit.

8. If time on FortiToken has drifted, FortiGate unit will prompt user to enter a second code to confirm.
9. User gets the next code from their FortiToken device
10. User enters the second code at the prompt.
11. FortiGate unit uses both codes to update its clock to match the FortiToken and then proceeds as in step "Users

and user groups" on page 415.
The FortiToken authentication process is illustrated below:

When configured the FortiGate unit accepts the username and password, authenticates them either locally or
remotely, and prompts the user for the FortiToken code. The FortiGate then authenticates the FortiToken code.
When FortiToken authentication is enabled, the prompt field for entering the FortiToken code is automatically
added to the authentication screens.

Even when an Administrator is logging in through a serial or Telnet connection and their account is linked to a
FortiToken, that Administrator will be prompted for the token’s code at each login.

If you have attempted to add invalid FortiToken serial numbers, there will be no error
message. The serial numbers will simply not be added to the list.
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Adding FortiTokens to the FortiGate

Before one or more FortiTokens can be used to authenticate logons, they must be added to the FortiGate. The
import feature is used to enter many FortiToken serial numbers at one time. The serial number file must be a text
file with one FortiToken serial number per line.

Both FortiToken Mobile and physical FortiTokens store their encryption seeds on the
cloud, therefore you will only be able to register them to a single FortiGate or
FortiAuthenticator.

Because FortiToken-200CD seed files are stored on the CD, these tokens can be
registered on multiple FortiGates and/or FortiAuthenticators, but not simultaneously.

To manually add a FortiToken to the FortiGate - web-based manager:

1. Go to User & Device > FortiTokens.
2. Select Create New.
3. In Type, select Hard Token orMobile Token.
4. Enter one or more FortiToken serial numbers (hard token) or activation codes (mobile token).
5. Select OK.

For mobile token, you receive the activation code in the license certificate once you
purchase a license. FortiOS include a license for two mobile token at no cost.

To import multiple FortiTokens to the FortiGate - web-based manager:

1. Go to User & Device > FortiTokens.
2. Select Create New.
3. In Type, select Hard Token.
4. Select Import.
5. Select Serial Number File or Seed File, depending on which file you have.
6. Browse to the local file location on your local computer.
7. Select OK.

The file is imported.
8. Select OK.

To import FortiTokens to the FortiGate from External Sources - CLI:

FortiToken seed files (both physical and mobile versions) can be imported from either FTP or TFTP servers, or a
USB drive, allowing seed files to be imported from an external source more easily:

execute fortitoken import ftp <file name> <ip>[:ftp port] <Enter> <user> <password>
execute fortitoken import tftp <file name> <ip>
execute fortitoken import usb <file name>
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To import seed files for FortiToken Mobile, replace fortitoken with
fortitoken-mobile.

To add two FortiTokens to the FortiGate - CLI:

config user fortitoken
edit <serial_number>
next
edit <serial_number2>
next

end

Activating a FortiToken on the FortiGate

Once one or more FortiTokens have been added to the FortiGate unit, they must be activated before being
available to be associated with accounts.The process of activation involves the FortiGate querying FortiGuard
servers about the validity of each FortiToken. The serial number and information is encrypted before it is sent for
added security.

A FortiGate unit requires a connection to FortiGuard servers to activate a FortiToken.

To activate a FortiToken on the FortiGate unit - web-based manager:

1. Go to User & Device > FortiTokens.
2. Select one or more FortiTokens with a status of Available.
3. Right-click the FortiToken entry and select Activate.
4. Select Refresh.

The status of selected FortiTokens will change to Activated.
The selected FortiTokens are now available for use with user and admin accounts.

To activate a FortiToken on the FortiGate unit - CLI:

config user fortitoken
edit <token_serial_num>

set status activate
next

end

Associating FortiTokens with accounts

The final step before using the FortiTokens to authenticate logons is associating a FortiToken with an account.
The accounts can be local user or administrator accounts.

To add a FortiToken to a local user account - web-based manager:

1. Ensure that your FortiToken serial number has been added to the FortiGate successfully, and its status is
Available.

2. Go to User & Device > User Definition, and edit the user account.
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3. Enter the user'sEmail Address.
4. Enable Two-factor Authentication.
5. Select the user's FortiToken serial number from the Token list.
6. Select OK.

For mobile token, click on Send Activation Code to be sent to the email address
configured previously. The user will use this code to activate his mobile token. An
Email Service has to be set under System > Advanced in order to send the
activation code.

To add a FortiToken to a local user account - CLI:

config user local
edit <username>

set type password
set passwd "myPassword"
set two-factor fortitoken
set fortitoken <serial_number>
set email-to "username@example.com"
set status enable

next
end

To add a FortiToken to an administrator account - web-based manager:

1. Ensure that your FortiToken serial number has been added to the FortiGate successfully, and its status is
Available.

2. Go to System > Administrators, and edit the admin account.
This account is assumed to be configured except for two-factor authentication.

3. Enter admin'sEmail Address.
4. Enable Two-factor Authentication.
5. Select the user's FortiToken serial number from the Token list.
6. Select OK.

For mobile token, click on Send Activation Code to be sent to the email address
configured previously. The admin will use this code to activate his mobile token. An
Email Service has to be set under System > Advanced in order to send the
activation code.

To add a FortiToken to an administrator account - CLI:

config system admin
edit <username>

set password "myPassword"
set two-factor fortitoken
set fortitoken <serial_number>
set email-to "username@example.com"

next
end

The fortitoken keyword will not be visible until fortitoken is selected for the two-factor option.
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Before a new FortiToken can be used, it may need to be synchronized due to clock
drift.

FortiToken maintenance

Once FortiTokens are entered into the FortiGate unit, there are only two tasks to maintain them — changing the
status,

To change the status of a FortiToken between Activated and Locked - CLI:

config user fortitoken
edit <token_serial_num>

set status lock
next

end

Any user attempting to login using this FortiToken will not be able to authenticate.

To list the drift on all FortiTokens configured on this FortiGate unit - CLI:

# diag fortitoken info
FORTITOKEN DRIFT STATUS
FTK2000BHV1KRZCC 0 token already activated, and seed won't be returned
FTK2001C5YCRRVEE 0 token already activated, and seed won't be returned
FTKMOB4B94972FBA 0 provisioned
FTKMOB4BA4BE9B84 0 new
Total activated token: 0
Total global activated token: 0
Token server status: reachable

This command lists the serial number and drift for each FortiToken configured on this FortiGate unit. This
command is useful to check if it is necessary to synchronize the FortiGate and any particular FortiTokens.

FortiToken Mobile Push

A command under config system ftm-push allows you to configure the FortiToken Mobile Push services
server IP address and port number. The Push service is provided by Apple (APNS) and Google (GCM) for iPhone
and Android smartphones respectively. This will help to avoid tokens becoming locked after an already enabled
two-factor authentication user has been disabled.

CLI syntax

config system ftm-push
set server-ip <ip-address>
set server-port [1-65535] Default is 4433.

end

Note that the server-ip is the public IP address of the FortiGate interface that the FTM will call back to; it is
the IP address used by the FortiGate for incoming FTM calls.
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If an SSL VPN user authenticates with their token, then logs out and attempts to reauthenticate again within a
minte, a new message will display showing "Please wait x seconds to login again." This replaces a previous
error/permission denied message.

The "x" value will depend on the calculation of how much time is left in the current time step.

CLI syntax

config system interface
edit <name>

set allowaccess ftm
next

end

FortiGate supports when the FortiAuthenticator initiates FTM Push notifications, for
when users are attempting to authenticate through a VPN and/or RADIUS (with
FortiAuthenticator as the RADIUS server).

Monitoring users

To monitor user activity in the web-based manager, go toMonitor > Firewall User Monitor. The list of users
who are logged on is displayed with some information about them such as their user group, security policy ID,
how long they have been logged on, their IP address, traffic volume, and their authentication method as one of
FSSO, NTLM, or firewall (FW-auth).

From this screen you can de-authenticate all users who are logged on. The de-authenticate button is at the top
left of this screen.

To see information about banned users go toMonitor > Quarantine Monitor. Displayed information about
users who have been banned includes what application the triggered the ban (Application Protocol), the reason
for the ban (Cause or rule), Created, and when the ban expires.

Filtering the list of users

When there are many users logged on, it can be difficult to locate a specific user or multiple users to analyze.
Applying filters to the list allows you to organize the user list to meet your needs, or only display some the users
that meet your current requirements.

Select settings bottom at the top right of the screen to adjust columns that are displayed for users, including what
order they are displayed in. This can be very helpful in locating information you are looking for.

Each column heading has a grey filter icon. Click on the filter icon to configure a filter for the data displayed in that
column. Each column has similar options including a field to enter the filtering information, a check box to select
the negative of the text in the field, and the options to add more fields, apply the filter, clear all filters, or cancel
without saving. To enter multiple terms in the field, separate each of them with a comma. To filter entries that
contain a specific prefix, use an * (asterisk).

For example, to create a filter to display only users with an IP address of 10.11.101.x who authenticated using
one of security policies five through eight, and who belong to the user group Accounting.

1. Go toMonitor > Quarantine Monitor.
2. Enter 10.11.101.* and select Apply.
3. Select the filter icon beside Policy ID.
4. Enter 5-8 and select Apply.
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5. Select the filter icon beside User Group.
6. Enter Accounting and select Apply.

Login credentials for guest users shown in clear text on GUI and voucher

In FortiOS 5.6.4, login credentials for guest users is displayed/printed in clear text on
the GUI and in the voucher. It is also sent in clear text by SMS and email.

User groups
A user group is a list of user identities. An identity can be:

l a local user account (username/password stored on the FortiGate unit
l a remote user account (password stored on a RADIUS, LDAP, or TACACS+ server)
l a PKI user account with digital client authentication certificate stored on the FortiGate unit
l a RADIUS, LDAP, or TACACS+ server, optionally specifying particular user groups on that server
l a user group defined on an FSSO server.

Security policies and some types of VPN configurations allow access to specified user groups only. This restricted
access enforces Role Based Access Control (RBAC) to your organization’s network and its resources. Users must
be in a group and that group must be part of the security policy.

In most cases, the FortiGate unit authenticates users by requesting their username and password. The FortiGate
unit checks local user accounts first. If a match is not found, the FortiGate unit checks the RADIUS, LDAP, or
TACACS+ servers that belong to the user group. Authentication succeeds when a matching username and
password are found. If the user belongs to multiple groups on a server, those groups will be matched as well.

FortiOS does not allow username overlaps between RADIUS, LDAP, or TACACS+
servers.

There are four types of FortiGate user groups: Firewall, Fortinet Single Sign-On (FSSO), Guest, and RADIUS
Single Sign-On (RSSO) user groups.

Firewall user groups

Firewall user groups are used locally as part of authentication. When a security policy allows access only to
specified user groups, users must authenticate. If the user authenticates successfully and is a member of one of
the permitted groups, the session is allowed to proceed.

This section includes:

l SSL VPN access
l IPsec VPN access
l Configuring a firewall user group
l User group timeouts
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SSL VPN access

SSL VPN settings include a list of the firewall user groups that can access the SSL VPN and the SSL VPN portal
that each group will use. When the user connects to the FortiGate unit via HTTPS on the SSL VPN port (default
10443), the FortiGate unit requests a username and password.

SSL VPN access also requires a security policy where the destination is the SSL interface.

IPsec VPN access

A firewall user group can provide access for dialup users of an IPsec VPN. In this case, the IPsec VPN phase 1
configuration uses the Accept peer ID in dialup group peer option. The user’s VPN client is configured with
the username as peer ID and the password as pre-shared key. The user can connect successfully to the IPsec
VPN only if the username is a member of the allowed user group and the password matches the one stored on
the FortiGate unit.

A user group cannot be used as a dialup group if any member of the group is
authenticated using an external authentication server.

Configuring a firewall user group

A user group can contain:

l local users, whether authenticated by the FortiGate unit or an authentication server
l PKI users
l authentication servers, optionally specifying particular user groups on the server

To create a Firewall user group - web-based manager:

1. Go to User & Device > User Groups and select Create New.
2. Enter a name for the user group.
3. In Type, select Firewall.
4. Add user names to to theMembers list.
5. Add authentication servers to the Remote groups list.

By default all user accounts on the authentication server are members of this FortiGate user group. To include
only specific user groups from the authentication server, deselect Any and enter the group name in the
appropriate format for the type of server. For example, an LDAP server requires LDAP format, such as:
cn=users,dn=office,dn=example,dn=com
Remote servers must already be configured in User & Device.

6. Select OK.

To create a firewall user group - CLI example:

In this example, the members of accounting_group are User1 and all of the members of rad_
accounting_group on myRADIUS external RADIUS server.

config user group
edit accounting_group

set group-type firewall
set member User1 myRADIUS
config match
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edit 0
set server-name myRADIUS
set group-name rad_accounting_group

end
end

Matching user group names from an external authentication server might not work if
the list of group memberships for the user is longer than 8000 bytes. Group names
beyond this limit are ignored.

server_name is the name of the RADIUS, LDAP, or TACACS+ server, but it must be a member of this group
first and must also be a configured remote server on the FortiGate unit.

group_name is the name of the group on the RADIUS, LDAP, or TACACS+ server such as “engineering” or
“cn=users,dc=test,dc=com”.

Before using group matching with TACACS+, you must first enable authentication. For example if you have a
configured TACACS+ server called myTACS, use the following CLI commands.

config user tacacs+
edit myTACS
set authorization enable
next

end

User group timeouts

User groups can have timeout values per group in addition to FortiGate-wide timeouts. There are essentially
three different types of timeouts that are configurable for user authentication on the FortiGate unit — idle
timeout, hard timeout, and session timeout. These are in addition to any external timeouts such as those
associated with RADIUS servers.

If VDOMs are enabled, the global level user setting authtimeout is the default all VDOMs inherit. If VDOMs
are not enabled, user settings authtimeout is the default. The default timeout value is used when the
authtimeout keyword for a user group is set to zero.

Each type of timeout will be demonstrated using the existing user group example_group. Timeout units are
minutes. A value of zero indicates the global timeout is used.

Membership in multiple groups

When a user belongs to multiple groups in RADIUS groups, the group auth-timeout values are ignored. Instead
the global timeout value is used. The default value is 5 minutes, but it can be set from 1 to 43200 minutes (30
days).

config user setting
set auth-timeout-type idle-timeout
set auth-timeout 300

end

Idle timeout

The default type of timeout is idle timeout. When a user initiates a session, it starts a timer. As long as data is
transferred in this session, the timer continually resets. If data flow stops, the timer is allowed to advance until it
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reaches its limit. At that time the user has been idle for too long, and the user is forced to re-authenticate before
traffic is allowed to continue in that session.

To configure user group authentication idle timeout - CLI:

config user settings
set auth-timeout-type idle-timeout

end
config user group

edit example_group
set authtimeout 5 //range is 0-43200 minutes (0 = use global authtimeout value)

next
end

Hard timeout

Where the idle timeout is reset with traffic, the hard timeout is absolute. From the time the first session a user
establishes starts, the hard timeout counter starts. When the timeout is reached, all the sessions for that user
must be re-authenticated. This timeout is not affected by any event.

To configure user group authentication hard timeout - CLI:

config user settings
set auth-timeout-type hard-timeout

end
config user group

edit example_group
set authtimeout 43200 //range is 0-43200 minutes (0 = use global authtimeout value)

next
end

Session timeout

The session timeout works much like the hard timeout in that its an absolute timer that can not be affected by
events. However, when the timeout is reached existing sessions may continue but new sessions are not allowed
until re-authentication takes place.

To configure a user group authentication new session hard timeout - CLI:

config user setting
set auth-timeout-type new-session

end

config user group
edit example_group

set authtimeout 30 //range is 0-43200 minutes (0 = use global authtimeout value)
next

end

SSO user groups

SSO user groups are part of FSSO authentication and contain only Windows or Novell network users. No other
user types are permitted as members. Information about the Windows or Novell user groups and the logon
activities of their members is provided by the Fortinet Single Sign On (FSSO) which is installed on the network
domain controllers.
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You can specify FSSO user groups in security policies in the same way as you specify firewall user groups. FSSO
user groups cannot have SSL VPN or dialup IPsec VPN access.

For information about configuring FSSO user groups, see Creating Fortinet Single Sign-On (FSSO) user groups
on page 544. For complete information about installing and configuring FSSO, see Agent-based FSSO on page
508.

Configuring Peer user groups

Peer user groups can only be configured using the CLI. Peers are digital certificate holders defined using the
config user peer command. The peer groups you define here are used in dialup IPsec VPN configurations
that accept RSA certificate authentication from members of a peer certificate group.

To create a peer group - CLI

config user peergrp
edit vpn_peergrp1

set member pki_user1 pki_user2 pki_user3
end

Viewing, editing and deleting user groups

To view the list of FortiGate user groups, go to User & Device > User Groups.

Editing a user group

When editing a user group in the CLI you must set the type of group this will be — either a firewall group, a
Fortinet Single Sign-On Service group (FSSO), a Radius based Single Sign-On Service group (RSSO), or a guest
group. Once the type of group is set, and members are added you cannot change the group type without
removing the members.

In the web-based manager, if you change the type of the group any members will be removed automatically.

To edit a user group - web-based manager

1. Go to User & Device > User Groups.
2. Select the user group that you want to edit.
3. Select the Edit button.
4. Modify the user group as needed.
5. Select OK.

To edit a user group - CLI

This example adds user3 to Group1. Note that you must re-specify the full list of users:

config user group
edit Group1
set group-type firewall

set member user2 user4 user3
end
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Deleting a user group

Before you delete a user group, you must ensure there are no objects referring to, it such as security policies. If
there are, you must remove those references before you are able to delete the user group.

To remove a user group - web-based manager

1. Go to User & Device > User Groups.
2. Select the user group that you want to remove.
3. Select the Delete button.
4. Select OK.

To remove a user group - CLI

config user group
delete Group2

end

SSL renegotiation in firewall authentication

The auth-ssl-allow-renegotiation option is available under config user setting to allow/forbid
SSL renegotiation in firewall authentication. The default value is disable, where a session would be terminated
by authd once renegotiation is detected and this login would be recorded as a failure. Other behavior follows
regular authentication settings.

To enable SSL renegotiation - CLI

config user setting
set auth-ssl-allow-renegotiation enable

end
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Visitors to your premises might need user accounts on your network for the duration of their stay. If you are
hosting a large event such as a conference, you might need to create many such temporary accounts. The
FortiOSGuest Management feature is designed for this purpose.

A guest user account User ID can be the user’s email address, a randomly generated string, or an ID that the
administrator assigns. Similarly, the password can be administrator-assigned or randomly generated.

You can create many guest accounts at once using randomly-generated User IDs and passwords. This reduces
administrator workload for large events.

User’s view of guest access

1. The user receives an email, SMSmessage, or printout from a FortiOS administrator listing a User ID and
password.

2. The user logs onto the network with the provided credentials.
3. After the expiry time, the credentials are no longer valid.

Administrator’s view of guest access

1. Create one or more guest user groups.
All members of the group have the same characteristics: type of User ID, type of password, information fields
used, type and time of expiry.

2. Create guest accounts using Guest Management.
3. Use captive portal authentication and select the appropriate guest group.

Configuring guest user access
To set up guest user access, you need to create at least one guest user group and add guest user accounts.
Optionally, you can create a guest management administrator whose only function is the creation of guest
accounts in specific guest user groups. Otherwise, any administrator can do guest management.

Creating guest management administrators

To create a guest management administrator

1. Go to System > Administrators and create a regular administrator account.
2. Select Restrict to Provision Guest Accounts.
3. InGuest Groups, add the guest groups that this administrator manages.

Creating guest user groups

The guest group configuration determines the fields that are provided when you create a guest user account.

To create a guest user group:

1. Go to User & Device > User Groups and select Create New.
2. Enter the following information:
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Name Enter a name for the group.

Type Guest

Enable Batch Account
Creation

Create multiple accounts automatically. When this is enabled:
l User ID and Password are set to Auto-Generate.
l The user accounts have onlyUser ID, Password, and Expiration

fields. Only the Expiration field is editable. If the expiry time is a
duration, such as “8 hours”, this is the time after first login.

l You can print the account information. Users do not receive email
or SMS notification.

See To create multiple guest user accounts automatically on page 437.

User ID Select one of:
l Email — User’s email address
l Specify— Administrator assigns user ID
l Auto-Generate — FortiGate unit creates a random user ID

Password Select one of:
l Specify— Administrator assigns user ID
l Auto-Generate — FortiGate unit creates a random password
l Disable — no password

Expire Type Choose one of:
l Immediately— expiry time is counted from creation of account
l After first login — expiry time is counted from user’s first login

Default Expire Time Set the expire time. The administrator can change this for individual users.

Enable Name If enabled, user must provide a name.

Enable Sponsor If enabled, user form has Sponsor field. Select Required if required.

Enable Company If enabled, user form has Company field. Select Requiredif required.

Enable Email If enabled, user is notified by email.

Enable SMS If enabled, user is notified by SMS. Select whether FortiGuard Messaging
Service or a another SMS provider is used.

Creating guest user accounts

Guest user accounts are not the same as local user accounts created in User & Device > User Definition.
Guest accounts are not permanent; they expire after a defined time period. You create guest accounts in User
& Device > Guest Management.

To create a guest user account

1. Go to User & Device > Guest Management.
2. InGuest Groups, select the guest group to manage.
3. Select Create New and fill in the fields in the New User form.
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Fields marked Optional can be left blank. The guest group configuration determines the fields that are available.
4. Select OK.

To create multiple guest user accounts automatically

1. Go to User & Device > Guest Management.
2. InGuest Groups, select the guest group to manage.

The guest group must have the Enable Batch Guest Account Creation option enabled.
3. Select Create New > Multiple Users.

Use the down-pointing caret to the right of Create New.
4. EnterNumber of Accounts.
5. Optionally, change the Expiration.
6. Select OK.

Guest Management Account List

Go to User & Device > Guest Management to create, view, edit or delete guest user accounts.

Create New Creates a new guest user account.

Edit Edit the selected guest user account.

Delete Delete the selected guest user account.

Purge Remove all expired accounts from the list.

Send Send the user account information to a printer or to the guest. Depending on the group
settings and user information, the information can be sent to the user by email or
SMS.

Refresh Update the list.

Guest Groups Select the guest group to list. New accounts are added to this group.

User ID The user ID. Depending on the guest group settings, this can be the user’s email
address, an ID that the administrator specified, or a randomly-generated ID.

Expires Indicates a duration such as “3 hours”. A duration on its own is relative to the present
time. Or, the duration is listed as “after first login.”

Guest access in a retail environment
Some retail businesses such as coffee shops provide free Wi-Fi Internet access for their customers. For this type
of application, the FortiOS guest management feature is not required; the Wi-Fi access point is open and
customers do not need logon credentials. However, the business might want to contact its customers later with
promotional offers to encourage further patronage. Using an Email Collection portal, it is possible to collect
customer email addresses for this purpose. The security policy grants network access only to users who provide a
valid email address.
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The first time a customer’s device attempts to use the Wi-Fi connection, FortiOS requests an email address,
which it validates. The customer’s subsequent connections go directly to the Internet without interruption.

Creating an email harvesting portal

The customer’s first contact with your network will be with a captive portal which presents a web page requesting
an email address. When FortiOS has validated the email address, the customer’s device MAC address is added
to the Collected Emails device group.

To create the email collection portal:

1. Go toWiFi & Switch Controller > SSID and edit your SSID.
2. Set Security Mode to Captive Portal.
3. Set Portal Type to Email Collection.
4. Optionally, in Customize Portal Messages select Email Collection.
You can change the portal content and appearance. See Customizing captive portal pages on page 468.

To create the email collection portal - CLI:

In this example the freewifiWi-Fi interface is modified to present an email collection captive portal.

config wireless-controller vap
edit freewifi

set security captive-portal
set portal-type email-collect

end

Creating the security policy

You need configure a security policy that allows traffic to flow from the Wi-Fi SSID to the Internet interface but
only for members of the Collected Emails device group. This policy must be listed first. Unknown devices are not
members of the Collected Emails device group, so they do not match the policy.

To create the security policy:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information:

Incoming Interface freewifi

Source Address all

Source Device Type Collected Emails

Outgoing Interface wan1

Destination Address all

Schedule always

Service ALL

438 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Managing Guest Access

Action ACCEPT

NAT On

3. Select OK.

To create the authentication rule - CLI:

config firewall policy
edit 3

set srcintf "freewifi"
set dstintf "wan1"
set srcaddr "all"
set action accept
set devices collected-emails
set nat enable
set schedule "always"
set service "ALL"

end

Checking for harvested emails

In the web-based manager, go to User & Device > Device Inventory. In the CLI you can use the diagnose
user device list command. For example,

FGT-100D # diagnose user device list
hosts

vd 0 d8:d1:cb:ab:61:0f gen 35 req 30 redir 1 last 43634s 7-11_2-int
ip 10.0.2.101 ip6 fe80::dad1:cbff:feab:610f
type 2 'iPhone' src http c 1 gen 29
os 'iPhone' version 'iOS 6.0.1' src http id 358 c 1
email 'yo@yourdomain.com'

vd 0 74:e1:b6:dd:69:f9 gen 36 req 20 redir 0 last 39369s 7-11_2-int
ip 10.0.2.100 ip6 fe80::76e1:b6ff:fedd:69f9
type 1 'iPad' src http c 1 gen 5
os 'iPad' version 'iOS 6.0' src http id 293 c 1
host 'Joes’s-iPad' src dhcp
email 'you@fortinet.com'

Fall-through authentication policies

User authentication policies have an implicit fall-through feature that intentionally causes policy matching to fall
through to a policy lower on the list that can also match the traffic. In other words the first user policy that is
matched in the policy list, based on standard policy criteria, isn’t the only policy that can be matched.

Fall-through is intended to match users in different user groups with different policies. For example, consider an
organization with two user groups where one group requires a web filtering profile, while the other requires virus
scanning. In this example, you would edit two basic Internet access policies: policy 1 assigning User Group A
with aWeb Filtering profile, and policy 2 assigning User Group B with an AntiVirus profile. Both policies are
also assigned to the same internal subnet, named subnet1.

In this configuration, all users from subnet1will see an authentication prompt. If the user is found in User
Group A, the traffic is accepted by policy 1 and is filtered by theWeb Filtering profile. If the user is found in
User Group B, the traffic is accepted by policy 2 and is virus scanned.
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The fall-through feature is required for users to be matched with policy 2. Without the fall-through feature, traffic
would never be matched with policy 2.
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When you have configured authentication servers, users, and user groups, you are ready to configure security
policies and certain types of VPNs to require user authentication.

This section describes:

l Authentication timeout
l Password policy
l Authentication protocols
l Authentication in Captive Portals
l Authentication in security policies
l Authentication replacement messages
l VPN authentication

Authentication timeout
An important feature of the security provided by authentication is that it is temporary—a user must re-
authenticate after logging out. Also if a user is logged on and authenticated for an extended period of time, it is a
good policy to have them re-authenticate at set periods. This ensures a user’s session is cannot be spoofed and
used maliciously for extended periods of time— re-authentication will cut any spoof attempts short. Shorter
timeout values are more secure.

Security authentication timeout

You set the security user authentication timeout to control how long an authenticated connection can be idle
before the user must authenticate again. The maximum timeout is 1440 minutes (24 hours).

To set the security authentication timeout - web-based manager:

1. Go to User & Device > Authentication Settings.
2. Enter the Authentication Timeout value in minutes.

The default authentication timeout is 5 minutes.
3. Select Apply.

SSL VPN authentication timeout

You set the SSL VPN user authentication timeout (Idle Timeout) to control how long an authenticated
connection can be idle before the user must authenticate again. The maximum timeout is 259 200 seconds. The
default timeout is 300 seconds.

To set the SSL VPN authentication timeout - web-based manager:

1. Go to VPN > SSL-VPN Settings.
2. Under Idle Logout, make sure that Logout users when inactive for specified period is enabled and enter

the Inactive For value (seconds).
3. Select Apply.
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Password policy
Password authentication is effective only if the password is sufficiently strong and is changed periodically. By
default, the FortiGate unit requires only that passwords be at least eight characters in length, but up to 128
characters is permitted. You can set a password policy to enforce higher standards for both length and complexity
of passwords. Password policies can apply to administrator passwords or IPsec VPN preshared keys.

To set a password policy in the web-based manager, go to System > Settings. In the CLI, use the config
system password-policy command.

Users usually create passwords composed of alphabetic characters and perhaps some numbers. Password policy
can require the inclusion of uppercase letters, lowercase letters, numerals or punctuation characters.

Configuring password minimum requirement policy

Best practices dictate that passwords include:

l one or more uppercase characters
l one or more lower case characters
l one or more of the numerals
l one or more special characters.

The minimum number of each of these types of characters can be set in both the web-based manager and the
CLI.

The following procedures show how to force administrator passwords to contain at least two uppercase, four
lower care, two digits, and one special character. Leave the minimum length at the default of eight characters.

To change administrator password minimum requirements - web-based manager:

1. Go to System > Settings.
2. Select Enable Password Policy.
3. Select Must Contain at Least.
4. Enter the following information:

Upper Case Letters 2

Lower Case Letters 4

Numbers 2

Special Characters 1

5. UnderApply Password Policy to, select Administrator Password.
6. Select Apply.

To change administrator password minimum requirements - CLI:

config system password-policy
set status enable
set apply-to admin-password
set min-upper-case-letter 2
set min-lower-case-letter 4
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set min-number 2
set min-non-alphanumeric 1
set change-4-characters enable

end

The change-4-characters option forces new passwords to change a minimum of four characters in the old
password. Changing fewer characters results in the new password being rejected. This option is only available in
the CLI.

To configure a guest administrator password policy - CLI:

As of FortiOS 5.4, a password policy can also be created for guest administrators. The following command shows
all possible commands, which are also available under config system password-policy.

config system password-policy
set status {enable | disable} Enable/disable password policy.
set apply-to {guest-admin-password} Guest admin to which this password policy applies.
set minimum-length <8-128> Minimum password length.
set min-lower-case-letter <0-128> Min. lowercase characters in password.
set min-upper-case-letter <0-128> Min. uppercase characters in password.
set min-non-alphanumeric <0-128> Min. non-alphanumeric characters in password.
set min-number <0-128> Min. numeric characters in password.
set change-4-characters {enable | disable} Enable/disable changing at least 4 characters for

new password.
set expire-status {enable | disable} Enable/disable password expiration.
set expire-day <1-999> Number of days before password expires.
set reuse-password {enable | disable} Enable/disable reuse of password.

end

Password best practices

In addition to length and complexity, there are security factors that cannot be enforced in a policy. Guidelines
issued to users will encourage proper password habits.

Best practices dictate that password expiration also be enabled. This forces passwords to be changed on a
regular basis. You can set the interval in days. The more sensitive the information this account has access to, the
shorter the password expiration interval should be. For example 180 days for guest accounts, 90 days for users,
and 60 days for administrators.

Avoid:

l real words found in any language dictionary
l numeric sequences, such as “12345”
l sequences of adjacent keyboard characters, such as “qwerty”
l adding numbers on the end of a word, such as “hello39”
l adding characters to the end of the old password, such as “hello39” to “hello3900”
l repeated characters
l personal information, such as your name, birthday, or telephone number.

In the case where the FortiGate is handling multiple keytabs in Kerberos
authentication, use different passwords when generating each keytab.
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Maximum logon attempts and blackout period

When you logon and fail to enter the correct password you could be a valid user, or a hacker attempting to gain
access. For this reason, best practices dictate to limit the number of failed attempts to logon before a blackout
period where you cannot logon.

To set a maximum of five failed authentication attempts before the blackout, using the following CLI command:

config user setting
set auth-invalid-max 5

end

To set the length of the blackout period to five minutes, or 300 seconds, once the maximum number of failed
logon attempts has been reached, use the following CLI command:

config user setting
set auth-blackout-time 300

end

Authentication protocols
When user authentication is enabled on a security policy, the authentication challenge is normally issued for any
of the four protocols, HTTP, HTTPS, FTP, and Telnet, which are dependent on the connection protocol. By
making selections in the Protocol Support list, the user controls which protocols support the authentication
challenge. The user must connect with a supported protocol first, so that they can subsequently connect with
other protocols.

For example, if you have selected HTTP, FTP, or Telnet, a username and password-based authentication occurs.
The FortiGate unit then prompts network users to input their security username and password. If you have
selected HTTPS, certificate-based authentication (HTTPS, or HTTP redirected to HTTPS only) occurs.

FTP and Telnet authentication replacement messages cannot be customized. For
HTTP and HTTPS replacement messages see Authentication replacement messages
on page 446.

For certificate-based authentication, you must install customized certificates on the FortiGate unit and on the
browsers of network users. If you do not install certificates on the network user’s web browser, the network users
may see an SSL certificate warning message and have to manually accept the default FortiGate certificate. The
network user’s web browser may deem the default certificate as invalid.

When you use certificate authentication, if you do not specify any certificate when you create the security policy,
the global settings are used. If you specify a certificate, the per-policy setting will overwrite the global setting. For
more information about the use of certification authentication see Certificate-based authentication on page 474.

To set the authentication protocols

1. Go to User & Device > Authentication Settings.
2. In Protocol Support, select the required authentication protocols.
3. If using HTTPS protocol support, in Certificate, select a Local certificate from the drop-down list.
4. Select Apply.
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Authentication in Captive Portals
Network interfaces, including WiFi interfaces, can perform authentication at the interface level using a captive
portal — an HTML form that requests the user’s name and password. A captive portal is useful where all users
connecting to the network interface must authenticate. Optionally, on a WiFi interface, the captive portal can be
combined with a terms of service disclaimer to which the user must agree before gaining access. For more
information, see Captive portals on page 466.

Once successfully authenticated, the user’s session passes to the firewall.

Authentication in security policies
Security policies control traffic between FortiGate interfaces, both physical interfaces and VLAN subinterfaces.
The firewall tries to match the session’s user or group identity, device type, destination, etcetera to a security
policy. When a match is found, the user connects to the requested destination. If no security policy matches, the
user is denied access.

A user who has not already been authenticated by a captive portal, FSSO, or RSSO can match only policies
where no user or user group is specified. If no such policy exists, the firewall requests authentication. If the user
can authenticate and the session can be matched to a policy, the user connects to the requested destination,
otherwise, the user is denied access.

This section includes:

l Enabling authentication protocols
l Authentication replacement messages
l Access to the Internet
l Configuring authentication security policies
l Identity-based policy
l NTLM authentication
l Certificate authentication
l Restricting number of concurrent user logons

Enabling authentication protocols

Users can authenticate using FTP, HTTP, HTTPS, and Telnet. However, these protocols must be enabled first.

Another authentication option is to redirect any attempts to authenticate using HTTP to a more secure channel
that uses HTTPS. This forces users to a more secure connection before entering their user credentials.

To enable support for authentication protocols - web-based manager:

1. Go to User & Device > Authentication Settings.
2. Select one or more of HTTP, HTTPS, FTP, Telnet, or Redirect HTTPChallenge to a Secure Channel (HTTPS).

Only selected protocols will be available for use in authentication.
3. Select the Certificate to use, for example Fortinet_Factory.
4. Select Apply.

To enable support for authentication protocols - CLI:

config user setting
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set auth-type ftp http https telnet
set auth-cert Fortinet_Factory

end

As of FortiOS 5.4, the Fortinet_Factory certificate has been re-signed with an
expiration date of 2038. It is used instead of Fortinet_ Factory2, which has
been removed.

Authentication replacement messages
A replacement message is the body of a webpage containing a message about a blocked website message, a file
too large message, a disclaimer, or even a login page for authenticating. The user is presented with this message
instead of the blocked content.

Authentication replacement messages are the prompts a user sees during the security authentication process
such as login page, disclaimer page, and login success or failure pages. These are different from most
replacement messages because they are interactive requiring a user to enter information, instead of simply
informing the user of some event as other replacement messages do.

Replacement messages have a system-wide default configuration, a per-VDOM configuration, and disclaimers
can be customized for multiple security policies within a VDOM.

These replacement messages are used for authentication using HTTP and HTTPS. Authentication replacement
messages are HTML messages. You cannot customize the security authentication messages for FTP and Telnet.

The authentication login page and the authentication disclaimer include replacement tags and controls not found
on other replacement messages.

More information about replacement messages can be found in the config system replacemsg section of
the FortiOS CLI Reference.

List of authentication replacement messages

Replacement message
name (CLI name) Description

Login challenge page
(auth-challenge-page)

This HTML page is displayed if security users are required to answer a
question to complete authentication. The page displays the question and
includes a field in which to type the answer. This feature is supported by
RADIUS and uses the generic RADIUS challenge-access auth response.
Usually, challenge-access responses contain a Reply-Message attribute
that contains a message for the user (for example, “Please enter new
PIN”). This message is displayed on the login challenge page. The user
enters a response that is sent back to the RADIUS server to be verified.

The Login challenge page is most often used with RSARADIUS server for
RSA SecurID authentication. The login challenge appears when the server
needs the user to enter a new PIN. You can customize the replacement
message to ask the user for a SecurID PIN.

This page uses the %%QUESTION%% tag.
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Replacement message
name (CLI name) Description

Disclaimer page

(auth-disclaimer-page-1)
(auth-disclaimer-page-2)
(auth-disclaimer-page-3)

This page prompts user to accept the displayed disclaimer when leaving
the captive portal to access Internet resources. It is displayed when the
captive portal type isAuthentication and Disclaimer orDisclaimer
Only.

In the CLI, the auth-disclaimer-page-2 and auth-disclaimer-page-3 pages
seamlessly extend the size of the disclaimer page from 8 192 characters to
16 384 and 24 576 characters respectively. In the web-based manager this
is handled automatically.

See Disclaimer on page 449.

Email token page
(auth-email-token-page)

The page prompting a user to enter their email token. See Email on page
1.

FortiToken page
(auth-fortitoken-page)

The page prompting a user to enter their FortiToken code. See FortiToken
on page 422.

Keepalive page
(auth-keepalive-page)

The HTML page displayed with security authentication keepalive is
enabled using the following CLI command:

config system globalset auth-keepalive enable
end

Authentication keepalive keeps authenticated firewall sessions from ending
when the authentication timeout ends. In the web-based manager, go to
User & Device > Authentication Settings to set the Authentication
Timeout.

This page includes%%TIMEOUT%%.

Login failed page
(auth-login-failed-page)

The Disclaimer page replacement message does not re-direct the user to a
redirect URL or the security policy does not include a redirect URL. When a
user selects the button on the disclaimer page to decline access through
the FortiGate unit, the Declined disclaimer page is displayed.

Login page
(auth-login-page)

The authentication HTML page displayed when users who are required to
authenticate connect through the FortiGate unit using HTTP or HTTPS.

Prompts the user for their username and password to login.

This page includes%%USERNAMEID%% and %%PASSWORDID%%
tags.

Declined disclaimer page
(auth-reject-page)

The page displayed if a user declines the disclaimer page. See Disclaimer
on page 449.
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Replacement message
name (CLI name) Description

SMS Token page
(auth-sms-token-page)

The page prompting a user to enter their SMS token. See SMS on page
421.

Success message
(auth-success-msg)

The page displayed when a user successfully authenticates. Prompts user
to attempt their connection again (as the first was interrupted for
authentication).

Access to the Internet

A policy for accessing the Internet is similar to a policy for accessing a specific network, but the destination
address is set to all. The destination interface is the one that connects to the Internet Service Provider (ISP). For
general purpose Internet access, the Service is set to ALL.

Access to HTTP, HTTPS, FTP and Telnet sites may require access to a domain name service. DNS requests do
not trigger authentication. You must configure a policy to permit unauthenticated access to the appropriate DNS
server, and this policy must precede the policy for Internet access. Failure to do this will result in the lack of a
DNS connection and a corresponding lack of access to the Internet.

Configuring authentication security policies

To include authentication in a security policy, the policy must specify user groups. A security policy can
authenticate by certificate, FSSO, and NTLM. The two exceptions to this are RADIUS SSO and FSSO Agents.
See SSO using RADIUS accounting records on page 552, and Introduction to FSSO agents on page 509.

Before creating a security policy, you need to configure one or more users or user groups. For more information,
see Users and user groups on page 415.

Creating the security policy is the same as a regular security policy except you must select the action specific to
your authentication method:

Authentication methods allowed for each policy Action

Action Authentication method Where authentication is used

ACCEPT FSSO Agent or a security policy that specifies an
FSSO user group

Agent-based FSSO on page 508.

NTLM See NTLM authentication on page 450.

Certificates See Configuring certificate-based
authentication on page 487.

RADIUS SSO See SSO using RADIUS accounting
records on page 552.

DENY none none
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Disclaimer

AWiFi or SSL captive portal can include a disclaimer message presented after the user authenticates. The user
must agree to the terms of the disclaimer to access network resources.

Customizing authentication replacement messages

Customizing disclaimers or other authentication replacement messages involves changing the text of the
disclaimer message, and possibly the overall appearance of the message.

Changing the disclaimer in System > Replacement Messages is not the same as selecting to customize a
disclaimer used in a captive portal. The captive portal location is a customized disclaimer that inherits the default
format for the disclaimer message, but then can be customized for this portal.

To customize the disclaimer for a captive portal - web-based manager:

1. Go to Network > Interfaces. Either select an existing interface or create a new one.
2. Under Security Mode, select Captive Portal, and enable Customize Portal Messages.
3. Select the Edit icon. You can select and edit any of the pages. Change your text or layout as needed.

Enabling security logging

There are two types of logging that relate to authentication — event logging, and security logging.

When enabled, event logging records system events such as configuration changes, and authentication. To
configure event logging, go to Log & Report > Log Settings and enable Event Logging. Select the events
you want to log, such asUser activity event.

When enabled, security logging will log security profile and security policy traffic.

You must enable logging within a security policy, as well as the options that are applied to a security policy, such
as security profiles features. Event logs are enabled within the Event Log page.

For more information on logging, see the FortiOS Log and Reporting guide.

For more information on specific types of log messages, see the FortiOS Log Message Reference.

You need to set the logging severity level to Notification when configuring a logging
location to record traffic log messages.

To enable logging within an existing security policy - web-based manager:

1. Go to Policy & Objects > IPv4 Policy.
2. Expand to reveal the policy list of a policy.
3. Select the security policy you want to enable logging on and then select Edit.
4. To log all general firewall traffic, select the check box beside Log Allowed Traffic, and choose to enable

Security Events orAll Sessions.
5. Select OK.
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Identity-based policy

An identity-based policy (IBP) performs user authentication in addition to the normal security policy duties. If the
user does not authenticate, access to network resources is refused. This enforces Role Based Access Control
(RBAC) to your organization’s network and resources.

Identity-based policies also support Single Sign-On operation. The user groups selected in the policy are of the
Fortinet Single Sign-On (FSSO) type.

User authentication can occur through any of the following supported protocols, including: HTTP, HTTPS, FTP,
and Telnet. The authentication style depends on which of these protocols is included in the selected security
services group and which of those enabled protocols the network user applies to trigger the authentication
challenge.

For username and password-based authentication (HTTP, FTP, and Telnet) the FortiGate unit prompts network
users to enter their username, password, and token code if two-factor authentication is selected for that user
account. For certificate-based authentication, including HTTPS or HTTP redirected to HTTPS only, see
Certificate authentication on page 460.

With identity-based policies, the FortiGate unit allows traffic that matches the source and destination addresses,
device types, and so on. This means specific security policies must be placed beforemore general ones to be
effective.

When the identity-based policy has been configured, the option to customize authentication messages is
available. This allows you to change the text, style, layout, and graphics of the replacement messages associated
with this firewall policy. When enabled, customizing these messages follows the same method as changing the
disclaimer. See Disclaimer on page 449.

Types of authentication also available in identity-based policies are

l NTLM authentication
l Certificate authentication

NTLM authentication

NT LANManager (NTLM) protocol can be used as a fallback for authentication when the Active Directory (AD)
domain controller is unreachable. NTLM uses the web browser to send and receive authentication information.
See "NTLM" and "FSSO NTLM authentication support".

To enable NTLM

1. Edit the policy in the CLI to enable NTLM. For example, if the policy ID is 4:
2. Go to Policy & Objects > IPv4 Policy and note the ID number of your FSSO policy.
3. The policy must have an FSSO user group asSource User(s). There must be at least one FSSO Collector agent

configured on the FortiGate unit.
config firewall policy

edit 4
set ntlm enable

end

NTLM guest access

Guest profile access may be granted to users who fail NTLM authentication, such as visitors who have no user
credentials on the network. To allow guest user access, edit the FSSO security policy in the CLI, like this:
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config firewall policy
edit 4

set ntlm enable
set ntlm-guest enable

end

NTLM enabled browsers - CLI

User agent strings for NTLM enabled browsers allow the inspection of initial HTTP-User-Agent values, so that
non-supported browsers are able to go straight to guest access without needlessly prompting the user for
credentials that will fail. ntlm-guest must be enabled to use this option.

config firewall policy
edit 4

set ntlm enable
set ntlm-guest enable
set ntlm-enabled-browsers <user_agent_string>

next
end

<user_agent_string> is the name of the browser that is NTLM enabled. Examples of these values include
“MSIE”, “Mozilla” (which includes FireFox), and “Opera”.

Value strings can be up to 63 characters in length, and may not contain cross site scripting (XSS) vulnerability
characters such as brackets. The FortiGate unit prevents use of these characters to prevent exploit of cross site
scripting (XSS) vulnerabilities.

Kerberos authentication for explicit web and transparent web proxy users
Kerberos authentication is a method for authenticating both explicit web proxy and transparent web proxy users.
It has several advantages over NTLM challenge response:

l Does not require FSSO/AD agents to be deployed across domains.
l Requires fewer round-trips than NTLM SSO, making it less latency sensitive.
l Is (probably) more scalable than challenge response.
l Uses existing Windows domain components rather than added components.
l NTLM may still be used as a fallback for non-Kerberos clients.

Enhancements to Kerberos explicit and transparent web proxy

FortiOS 5.6.x authentication is managed by schemes and rules based on protocol and source address. As such,
configurable authentication settings have been introduced to enhance authentication.

CLI commands (config authentication rule, scheme, and setting) allow explicit proxy rules and
schemes to be created to separate user authentication (e.g. authentication rules and schemes used to match
conditions in order to identify users) from user authorization (proxy-based policies with users and/or user groups).

CLI syntax - config authentication rule

config authentication rule
edit <name>

set name <name>
set status {enable|disable}
set protocol {http|ftp|socks}
config srcaddr <addr-name or addrgrp-name>
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edit <name>
set name <ipv4-policy-name>

next
end
config srcaddr6 <addr-name or addrgrp-name>

edit <name>
set name <ipv6-policy-name>

next
end
set ip-based {enable|disable}
set active-auth-method <scheme-name>
set sso-auth-method <scheme-name>
set transaction-based {enable|disable} - basic scheme + session-based
set web-auth-cookie {enable|disable}
set comments <comments>

next
end

Note: As shown above, HTTP, FTP, and SOCKSv5 authentication protocols are supported for explicit proxy.

Authentication rules are used to receive user-identity, based on the values set for protocol and source address.
Having said this, if a rule fails to match based on source address, there will be no other attempt to match the rule,
however the next policy will be attempted. This occurs only when:

l there is an authentication rule, but no authentication method has been set (under config authentication
scheme; see below), so user identity cannot be found.

l the user is successfully matched in the rule, but fails to match the current policy.

Once a rule is positively matched through protocol and/or source address, it must also match the authentication
method specified (active-auth-method and sso-auth-method). These methods point to schemes, as
defined under config authentication scheme.

CLI syntax - config authentication scheme

config authentication scheme
edit <name>

set name <name>
set method {basic|digest|ntlm|form|negotiate|fsso|rsso}
set negotiate-ntlm {enable|disable}
set require-tfa {enable|disable}
set fsso-guest {enable|disable}
config user-database

edit <name>
set name {local|<ldap-server>|<radius-server>|<fsso-name>|<rsso-name>|<tacacs+-

name>}
next

end
next

end

Combining authentication rules and schemes, granular control can be exerted over users and IPs, creating an
efficient process for users to successfully match a criteria before matching the policy.

Additional options can be set under config authentication setting.

CLI syntax - config authentication setting

config authentication setting
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set sso-scheme <scheme-name>
set active-scheme <scheme-name>
set captive-portal <host-name>
set captive-portal-port <tcp-port>

end

Integration of Transparent and Explicit proxy HTTP policy checking

ACLI command, under config firewall profile-protocol-options, allows HTTP policy checking
to be enable or disabled. When enabled, transparent traffic can be matched in a firewall policy and policy user
authentication can occur. In addition, separate SSL inspection policies can be created:

config firewall profile-protocol-options
edit <name>

set http-policy {enable|disable}
end

Internet Service Database in Explicit/Implicit proxy policies

CLI commands, under config firewall proxy-policy, implement the Internet Service Database (ISDB)
as the webproxy matching factor, and override IP pool is also support:

config firewall proxy-policy
edit <name>

set proxy {explicit-web|transparent-web|ftp|wanopt}
set dstintf <dst-name>
set poolname <ip-pool-name>

end

Multiple port/port range support for explicit web and explicit FTP proxy

Multiple port numbers and/or ranges can be set for explicit proxy, specifically for HTTP/HTTPS and FTP. Go to
Network > Explicit Proxy and configure settings under Explicit Web Proxy and Explicit FTP Proxy, or
under config web-proxy explicit in the CLI Console.

1. General configuration

1.1 Kerberos environment - Windows server setup

1. Build a Windows 2008 Platform server.
2. Enable domain configuration in windows server (dcpromo).
3. Set the domain name TEST.COM (realm name).

1.2 Create users

l testuser is a normal user (could be any existing domain user account).
l testfgt is the service name. In this case it should be the FQDN for the explicit proxy Interface, For example the

hostname in the client browser proxy config.
l Recommendation: create username all in lowercase (even if against corporate standards).

l The account only requires “domain users” membership
l Password set to never expire
l Set a very strong password
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1.3 Add FortiGate to DNS

Add the FortiGate FQDN in to the Windows DNS domain, as well as in-addr.arpa

For Lab/Testing add the FortiGate Domain name and IPmapping in the hosts file
(windows/system32/drivers/etc/hosts). e.g., TESTFGT.TEST.COM 10.10.1.10

1.4 Generate the Kerberos keytab

Use the ktpass command (found on Windows Servers and many domain workstations) to generate the Kerberos
keytab.

Example:

ktpass -princ HTTP/<domain name of test fgt>@realm -mapuser testfgt -pass <password> -
crypto all -ptype KRB5_NT_PRINCIPAL -out fgt.keytab

In the case where the FortiGate is handling multiple keytabs in Kerberos
authentication, use different passwords when generating each keytab.

The ktpass on older Windows servers (i.e. 2003) may not support the “all” crypto
option.

Example:

ktpass -princ HTTP/testfgt.test.com@TEST.COM -mapuser testfgt -pass 12345678 -crypto all -
ptype KRB5_NT_PRINCIPAL -out fgt.keytab

The realm name is always presented in uppercase, and prefixed with the “@”
character.

1.5 Encode base64

Use the base64 command (available in most Linux distros) command to encode the fgt.keytab file. Any LF (Line
Feed) need to be deleted from the file.

Example:

base64 fgt.keytab > fgt.txt

Use Notepad++ or some native Linux text editor. Windows Notepad and Wordpad are
likely to introduce errors.
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2. FortiGate configuration

2.1 Create LDAP Server instance

config user ldap
edit "ldap" <<< Required for authorization

set server "10.10.1.1" <<< LDAP server IP, normally it should be same as KDC server
set cnid "cn"
set dn "dc=test,dc=com"
set type regular
set username "CN=admin,CN=Users,DC=test,DC=com" <<< Your domain may require STARTTLS
set password <FOOS>

next
end

2.2 Define Kerberos as an authentication service

config user krb-keytab
edit "http_service"

set principal "HTTP/testfgt.test.com@TEST.COM" <<< Same as the principal name in 1.4
set ldap-server "ldap" <<< the defined ldap server for authoriztion
set keytab

"BQIAAABNAAIACkJFUkJFUi5DT00ABEhUVFAAGlRPTllfRkdUXzEwMERfQS5CRVJCRVIuQ09NAAAAAQA
AAAAKABcAEJQl0MHqovwplu7XzfENJzw=" <<< base64 endoding keytab data, created in step 1.5

next
end

2.3 Create user group(s)

config user group <<< the group is used for kerberos authentication
edit "testgrp"

set member "ldap"
config match

edit 1
set server-name "ldap" <<< Same as ldap-server option in krb-keytab
set group-name "CN=Domain Users,CN=Users,DC=TEST,DC=com"

next
end

next
end

2.4 Create firewall policy

config firewall proxy-policy
edit 1

set uuid 5e5dd6c4-952c-51e5-b363-120ad77c1414
set proxy explicit-web
set dstintf "port1"
set srcaddr "all"
set dstaddr "all"
set service "webproxy"
set action accept
set schedule "always"
set groups "CN=USERS LAB.PS FSSO"

next
end
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2.5 Diagnostics

Once the keytab is imported, check that it has been properly decoded. The filename generated will be relatively
random, but should be clearly visible.

Artoo-Deetoo (root) # fnsysctl ls -la /tmp/kt
drwxr--r-- 2  0   0 Fri Dec 2 10:06:43 2016    60 .
drwxrwxrwt 22 0   0 Tue Dec 6 14:28:29 2016    3280 ..
-rw-r--r-- 1  0   0 Fri Dec 2 10:06:43 2016    392 1.0.89.keytab

If there is no file present, then the file hasn’t decoded. Check the file for line feeds and
try again.

3. Client side walkthrough

3.1 Check Kerberos is working

Log on to the domain by using testuser, created in 1.2. Use the klist command to list ticket information. In the
below example, the client has received krbtgt, CIFS, and LDAP tickets. As there has been no interaction with the
FortiGate, there are no references to it.

C:\Users\glenk>klist Cached Tickets: (5)

C:\Users\glenk>klist
Cached Tickets: (5)
#0> Client: glenk @ home.local

Server: krbtgt/HOME.LOCAL @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x60a00000 -> forwardable forwarded renewable pre_authent
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#1> Client: glenk @ home.local

Server: krbtgt/HOME.LOCAL @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40e00000 -> forwardable renewable initial pre_authent
Start Time: 12/6/2016 14:58:04 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#2> Client: glenk @ home.local

Server: cifs/EthicsGradient.home.local @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40a40000 -> forwardable renewable pre_authent ok_as_delegate
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#3> Client: glenk @ home.local

Server: ldap/EthicsGradient.home.local @ HOME.LOCAL
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KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40a40000 -> forwardable renewable pre_authent ok_as_delegate
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#4> Client: glenk @ home.local

Server: LDAP/EthicsGradient.home.local/home.local @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40a40000 -> forwardable renewable pre_authent ok_as_delegate
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

3.2 Configure client

Set up web-proxy in browser through the FortiGate. This can be achieved via a PAC file or direct browser
configuration.

Some Firefox documentation indicates that it is necessary to make manual advanced
configuration changes to allow Kerberos authentication work. However, builds 48 (and
possibly much earlier) require no additional configuration beyond setting of the proxy
server.

3.3 Open a connection to the Internet

1. The client accesses the explicit proxy, but a HTTP 407 Proxy Authentication Required is returned.
2. As “Negotiate” is set, the client has knowledge of the KRBTGT, it requests a ticket from the KDC with a krb-tgs-

reqmessage. This includes the REALM (HOME.LOCAL) in the reg-body section, and the provided instances
SNAME and service (in this case, HTTP/artoo-deetoo.home.local).

3. The KDC responds with a next KRB-TGS-REP.
This ticket is then available on the client.

In the example below, the ticket-granted-service has issued Ticket #2.

#2> Client: glenk @ home.local
Server: HTTP/artoo-deetoo.home.local @ HOME.LOCAL
KerbTicket Encryption Type: RSADSI RC4-HMAC(NT)
Ticket Flags 0x40a00000 -> forwardable renewable pre_authent
Start Time: 12/6/2016 14:59:45 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: RSADSI RC4-HMAC(NT)

4. The conversation between the client and the proxy continues, as the client responds with the Kerberos ticket in the
response.
The whole process takes less than a second to complete. The user should be visible as a FSSO logon in the
Web UI.
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Transparent web-proxy Kerberos authentication

Transparent web-proxy is new to FortiOS 5.6, in which the FortiGate can process level 7 policy matching, even
when the explicit web-proxy is not enabled on the client's browser. The transparent web-proxy policy is set in
proxy-policy too. The policy matching rule is the same as the explicit web-proxy.

In the firewall policy level, transparent web-proxy is regarded as a special UTM. The HTTP/HTTPS traffic
matches the firewall policy first, then traffic is redirected to the web-proxy daemon. If the trasnparent web-proxy
feature is disabled, http-policy options in profile-protocol-options is used to enable transparent web-proxy feature.

IP-based

1. Captive portal and the captive portal port must be configured in transparent web-proxy for support of Kerberos
authentication:

config authentication setting
set captive-portal <fqdn-name>
set captive-portal-port "9998"

end

2. Authentication rule, scheme, and krb-keytab need to be configured for Kerberos authentication (note the
active-auth-method scheme referenced in the rule):

config authentication scheme
edit <kerberos-scheme>

set method negotiate
set negotiate-ntlm <enable>
set fsso-guest <disable>

next
end

config authentication rule
edit <name>

set status <enable>
set protocol <http>
set srcadrr "all"
set ip-based <enable>
set active-auth-method <kerberos-scheme>

next
end

config user krb-keytab
edit <name>

set principal "HTTP/TESTFGT.TEST.COM@TEST.COM"
set ldap-server "ldap"
set keytab <base64-encoding-keytab-data>

next
end

3. Configure LDAP and user group used for authorization:

config user ldap
edit "ldap"

set server "10.10.1.1"
set cnid
srt dn
set type <regular>
set username "CN=admin,CN=Users,DC=test,DC=com"
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set password ENC
aW5lIAHkPMf4D+ZCKpGMU3x8Fpq0G+7uIbAvpblbXFA5vLfgb4/oRBx+B6R/v+CMCetP84e+Gdz5zEcM
yOd3cjoBoIhFrpYJfXhRs4lSEOHezeVXfxwTSf5VJG+F11G/G5RpaY+AE8bortC8MBe7P2/uGQocFHu4
Ilulp5I6OJvyk6Ei3hDZMjTd8iPp5IkRJZVVjQ==

next
end

config user group
edit "testgrp"

set memeber "ldap"
config match

edit "1"
set server-name "ldap"
set group-name "CN=Domain Users,CN=Users,DC=TEST,DC=com"

next
end

next
end

4. Create proxy-policy, with groups as the authorizing policy-matching element:

config firewall proxy-policy
edit 1

set uuid 1bbb891a-9cd2-51e7-42ff-d1fa13cac3da
set proxy explicit-web
set dstintf "any"
set srcaddr "all"
set dstaddr "all"
set service "webproxy"
set action accept
set schedule "always"
set groups testgrp

next
end

5. UTM must be enabled in the firewall policy to support the transparent web-proxy:

config firewall policy
edit "1"

set name "policy1"
set uuid 8a6ceeac-b016-51e6-2b5c-165070d5bf50
set srcintf "mgmt1"
set dstintf "mgmt1"
set srcaddr "all"
set dstaddr "all"
set action <accept>
set schedule "always"
set service "ALL"
set utm-status <enable>
set profile-protocol-options "transparent-web-proxy"
set ssl-ssh-profile "deep-inspection"
set nat <enable>

next
end

config firewall profile-protocol-options
edit "transparent-web-proxy"

config http
set ports "80 8080"
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unset options
set http-policy enable
unset post-lang

end
...

next
end

Session-based with web-auth cookie

The web-auth-cookie feature is necessary for session-based authentication under transparent web-proxy.

The configuration is the same as for IP-based authentication, except ip-based is disabled in the authentication
rule:

config authentication rule
edit "kerberos-rules"

set status <enable>
set protocol <http>
set srcadrr "all"
set ip-based <disable>
set active-auth-method <kerberos-scheme>

next

config authentication setting
set captive-portal <fqdn-name>
set captive-portal-port "9998"

end

HTTP tunnel authentication

You can trigger user authentication on HTTPCONNECT request at the policy level. A new CLI entry has been
added under config firewall proxy-policy which will trigger the authentication process get-user, even
when there is no user or group configured.

Note that, as shown below, explicit web proxy must be set.

Syntax

config firewall proxy-policy
edit {policyid}

set proxy explicit-web
set http-tunnel-auth {enable | disable}

next
end

Certificate authentication

You can configure certificate-based authentication for FortiGate administrators, SSL VPN users, and IPsec VPN
users. See Configuring certificate-based authentication on page 487.

Certificates are also inherent to the HTTPS protocol, where the browser validates the server’s identity using
certificates. A site certificate must be installed on the FortiGate unit and the corresponding Certificate Authority
(CA) certificate installed in the web browser.

To force the use of HTTPS, go to User & Device > Authentication Settings and select Redirect HTTP
Challenge to a Secure Channel (HTTPS).
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Restricting number of concurrent user logons

Some users on your network may often have multiple account sessions open at one time either to the same
network resource or accessing to the admin interface on the FortiGate unit.

While there are valid reasons for having multiple concurrent sessions open, hackers also do this to speed up their
malicious work. Often a hacker is making multiple attempts to gain access to the internal network or the admin
interface of the FortiGate unit, usually from different IP addresses to appear to the FortiGate unit as legitimate
users. For this reason, the more concurrent sessions a hacker has open at once, the faster they will achieve their
goal.

To help prevent this, you can disallow concurrent administrative access using the same administrator user name.
This allows only one session with the same username even if it is from the same IP.

To disable concurrent administrator sessions - CLI:

config system global
set admin-concurrent disable

end

VPN authentication
All VPN configurations require users to authenticate. Authentication based on user groups applies to:

l SSL VPNs
l PPTP and L2TP VPNs
l an IPsec VPN that authenticates users using dialup groups
l a dialup IPsec VPN that uses XAUTH authentication (Phase 1)

You must create user accounts and user groups before performing the procedures in this section. If you create a
user group for dialup IPsec clients or peers that have unique peer IDs, their user accounts must be stored locally
on the FortiGate unit. You cannot authenticate these types of users using a RADIUS or LDAP server.

Configuring authentication of SSL VPN users

The general procedure for authenticating SSL VPN users is:

1. Configure user accounts.
2. Create one or more user groups for SSL VPN users.
3. Enable SSL VPN.
4. Optionally, set inactivity and authentication timeouts.
5. Configure a security policy with the user groups you created for SSL VPN users.

See FortiOS Handbook SSL VPN guide.

Configuring authentication timeout

By default, the SSL VPN authentication expires after 8 hours (28 800 seconds). You can change it only in the CLI,
and the time entered must be in seconds. The maximum time is 72 hours (259 200 seconds). For example, to
change this timeout to one hour, you would enter:

config vpn ssl settings
set auth-timeout 3600

end
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If you set the authentication timeout (auth-timeout) to 0 when you configure the timeout settings, the remote
client does not have to re-authenticate unless they log out of the system. To fully take advantage of this setting,
the value for idle-timeout has to be set to 0 also, so that the client does not time out if the maximum idle
time is reached. If the idle-timeout is not set to the infinite value, the system will log out if it reaches the
limit set, regardless of the auth-timeout setting.

Configuring authentication of remote IPsec VPN users

An IPsec VPN on a FortiGate unit can authenticate remote users through a dialup group. The user account name
is the peer ID and the password is the pre-shared key.

Authentication through user groups is supported for groups containing only local users. To authenticate users
using a RADIUS or LDAP server, you must configure XAUTH settings. See Configuring XAuth authentication.

To configure user group authentication for dialup IPsec - web-based manager:

1. Configure the dialup users who are permitted to use this VPN. Create a user group with Type:Firewall and add
them to it.
For more information, see Users and user groups on page 415

2. Go to VPN > IPsec Wizard, select Remote Access, choose a name for the VPN, and enter the following
information.

Incoming Interface Select the incoming interface name.

Authentication Method List of authentication methods available for users. Select Preshared Key
and enter the preshared key.

User Group Select the user group that is to be allowed access to the VPN. The listed
user groups contain only users with passwords on the FortiGate unit.

3. Select Next and continue configure other VPN parameters as needed.
4. Select OK.

To configure user group authentication for dialup IPsec - CLI example:

The peertype and usrgrp options configure user group-based authentication.

config vpn ipsec phase1
edit office_vpn

set interface port1
set type dynamic
set psksecret yORRAzltNGhzgtV32jend
set proposal 3des-sha1 aes128-sha1
set peertype dialup
set usrgrp Group1

end

Configuring XAuth authentication

Extended Authentication (XAuth) increases security by requiring additional user authentication information in a
separate exchange at the end of the VPN Phase 1 negotiation. The FortiGate unit asks the user for a username
and password. It then forwards the user’s credentials (the password is encrypted) to an external RADIUS or LDAP
server for verification.
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XAuth can be used in addition to or in place of IPsec phase 1 peer options to provide access security through an
LDAP or RADIUS authentication server. You must configure a dialup user group whose members are all
externally authenticated.

To configure authentication for a dialup IPsec VPN - web-based manager:

1. Configure the users who are permitted to use this VPN. Create a user group and add the users to the group.
For more information, see "Users and user groups" on page 415.

2. Go to VPN > IPsec Wizard, select Remote Access, choose a name for the VPN, and enter the following
information.

Incoming Interface Select the incoming interface name.

Authentication Method List of authentication methods available for users. Select Preshared Key
and enter the preshared key.

User Group Select the user group that is to be allowed access to the VPN. The listed
user groups contain only users with passwords on the FortiGate unit.

3. Select Next and continue configure other VPN parameters as needed.
4. Select OK.
5. Go to VPN > IPsec Tunnels, edit the Tunnel just created, select Convert To Custom Tunnel, and edit

XAUTH as following:

Type Select PAP, CHAP, orAUTO. Use CHAPwhenever possible. Use PAP
with all implementations of LDAP and with other authentication servers
that do not support CHAP, including some implementations of Microsoft
RADIUS. Use AUTO with the Fortinet Remote VPN Client and where the
authentication server supports CHAP but the XAuth client does not.

User Group Select the user group that is to have access to the VPN. The list of user
groups does not include any group that has members whose password is
stored on the FortiGate unit.

6. Select OK.
For more information about XAUTH configuration, see the IPsec VPN chapter of the FortiOS Handbook.

To configure authentication for a dialup IPsec VPN - CLI example:

The xauthtype and authusrgrp fields configure XAuth authentication.

config vpn ipsec phase1
edit office_vpn

set interface port1
set type dynamic
set psksecret yORRAzltNGhzgtV32jend
set proposal 3des-sha1 aes128-sha1
set peertype dialup
set xauthtype pap
set usrgrp Group1

end
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Some parameters specific to setting up the VPN itself are not shown here. For detailed information about
configuring IPsec VPNs, see the FortiOS Handbook IPsec VPN guide.

Configuring authentication of PPTP VPN users and user groups

Configuration of a PPTP VPN is possible only through the CLI. You can configure user groups and security
policies using either CLI or web-based manager.

LDAP user authentication is supported for PPTP, L2TP, IPsec VPN, and firewall
authentication.

However, with PPTP, L2TP, and IPsec VPN, PAP (Packet Authentication Protocol) is
supported, while CHAP (Challenge Handshake Authentication Protocol) is not.

To configure authentication for a PPTP VPN

1. Configure the users who are permitted to use this VPN. Create a security user group and add them to it.
For more information, see Users and user groups on page 415.

2. Configure the PPTP VPN in the CLI as in this example.
config vpn pptp

set status enable
set sip 192.168.0.100
set eip 192.168.0.110
set usrgrp PPTP_Group

end

The sip and eip fields define a range of virtual IP addresses assigned to PPTP clients.

Configure a security policy. The source interface is the one through which the clients will connect. The source
address is the PPTP virtual IP address range. The destination interface and address depend on the network to
which the clients will connect. The policy action is ACCEPT.

Configuring authentication of L2TP VPN users/user groups

Configuration of a L2TP VPN is possible only through the CLI. You can configure user groups and security policies
using either CLI or web-based manager.

LDAP user authentication is supported for PPTP, L2TP, IPsec VPN, and firewall
authentication.

However, with PPTP, L2TP, and IPsec VPN, PAP (Packet Authentication Protocol) is
supported, while CHAP (Challenge Handshake Authentication Protocol) is not.

To configure authentication for a L2TP VPN

1. Configure the users who are permitted to use this VPN. Create a user group and add them to it.
For more information, see Users and user groups on page 415.

2. Configure the L2TP VPN in the CLI as in this example.
config vpn l2tp

set status enable
set sip 192.168.0.100
set eip 192.168.0.110
set usrgrp L2TP_Group

end
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The sip and eip fields define a range of virtual IP addresses assigned to L2TP clients.

3. Configure a security policy. The source interface is the one through which the clients will connect. The source
address is the L2TP virtual IP address range. The destination interface and address depend on the network to
which the clients will connect. The policy action is ACCEPT.
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A captive portal is a convenient way to authenticate web users on wired or WiFi networks.

This section describes:

l Introduction to Captive portals
l Configuring a captive portal
l Customizing captive portal pages

Introduction to Captive portals
You can authenticate your users on a web page that requests the user’s name and password. Until the user
authenticates successfully, the authentication page is returned in response to any HTTP request. This is called a
captive portal.

After successful authentication, the user accesses the requested URL and can access other web resources, as
permitted by security policies. Optionally, the captive portal itself can allow web access to only the members of
specified user group.

The captive portal can be hosted on the FortiGate unit or on an external authentication server. You can configure
captive portal authentication on any network interface, including WiFi and VLAN interfaces.

When a captive portal is configured on a WiFi interface, the access point initially appears open. The wireless
client can connect to the access point with no security credentials, but sees only the captive portal authentication
page.

WiFi captive portal types:

l Authentication— until the user enters valid credentials, no communication beyond the AP is permitted.
l Disclaimer + Authentication— immediately after successful authentication, the portal presents the disclaimer

page—an acceptable use policy or other legal statement—to which the user must agree before proceeding.
l Disclaimer Only— the portal presents the disclaimer page—an acceptable use policy or other legal statement—

to which the user must agree before proceeding. The authentication page is not presented.
l Email Collection — the portal presents a page requesting the user’s email address, for the purpose of contacting

the person in future. This is often used by businesses who provide free WiFi access to their customers. The
authentication page is not presented.

Configuring a captive portal
Captive portals are configured on network interfaces. On a physical (wired) network interface, you edit the
interface configuration in Network > Interfaces and set Security Mode to Captive Portal. AWiFi interface
does not exist until the WiFi SSID is created. You can configure a WiFi captive portal at the time that you create
the SSID. Afterwards, the captive portal settings will also be available by editing the WiFi network interface in
Network > Interfaces.

To configure a wired Captive Portal - web-based manager:

1. Go to Network > Interfaces and edit the interface to which the users connect.
2. In Security Mode select Captive Portal.
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3. Enter

Authentication Portal Local - portal hosted on the FortiGate unit.

Remote - enter FQDN or IP address of external portal.

User Groups Select permitted user groups or select Use Groups from Policies, which
permits the groups specified in the security policy.

Use Groups from Policies is not available in WiFi captive portals.

Exempt List Select exempt lists whose members will not be subject to captive portal
authentication.

Customize Portal
Messages

Enable, then select Edit. See Customizing captive portal pages on page
468.

4. Select OK.

To configure a WiFi Captive Portal - web-based manager:

1. Go toWiFi & Switch Controller > SSID and create your SSID.
If the SSID already exists, you can edit the SSID or you can edit the WiFi interface in Network > Interfaces.

2. In Security Mode, select Captive Portal.

3. Enter

Portal Type The portal can provide authentication and/or disclaimer, or perform user
email address collection. See Introduction to Captive portals on page 466.

Authentication Portal Local - portal hosted on the FortiGate unit.

Remote - enter FQDN or IP address of external portal.

User Groups Select permitted user groups.
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Exempt List Select exempt lists whose members will not be subject to captive portal
authentication.

Customize Portal Messages Click the link of the portal page that you want to modify. See "Captive
portals" on page 468.

4. Select OK.

Exemption from the captive portal

A captive portal requires all users on the interface to authenticate. But some devices are not able to authenticate.
You can create an exemption list of these devices. For example, a printer might need to access the Internet for
firmware upgrades. Using the CLI, you can create an exemption list to exempt all printers from authentication.

config user security-exempt-list
edit r_exempt

config rule
edit 1

set devices printer
end

end

Customizing captive portal pages
These pages are defined in replacement messages. Defaults are provided. In the web-based manager, you can
modify the default messages in the SSID configuration by selecting Customize Portal Messages. Each SSID
can have its own unique portal content.

The captive portal contains the following default web pages:

l Login page—requests user credentials
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Typical modifications for this page would be to change the logo and modify some of the text.

You can change any text that is not part of the HTML code nor a special tag enclosed in double percent (%)
characters.

There is an exception to this rule. The line “Please enter your credentials to continue” is provided by the
%%QUESTION%% tag. You can replace this tag with text of your choice. Except for this item, you should not
remove any tags because they may carry information that the FortiGate unit needs.

l Login failed page—reports that the entered credentials were incorrect and enables the user to try again.
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The Login failed page is similar to the Login page. It even contains the same login form. You can change any text
that is not part of the HTML code nor a special tag enclosed in double percent (%) characters.

There is an exception to this rule. The line “Firewall authentication failed. Please try again.” is provided by the
%%FAILED_MESSAGE%% tag. You can replace this tag with text of your choice. Except for this item, you should
not remove any tags because they may carry information that the FortiGate unit needs.

l Disclaimer page—is a statement of the legal responsibilities of the user and the host organization to which the
user must agree before proceeding.(WiFi or SSL VPN only)
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l Declined disclaimer page—is displayed if the user does not agree to the statement on the Disclaimer page.
Access is denied until the user agrees to the disclaimer.
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Changing images in portal messages

You can replace the default Fortinet logo with your organization’s logo. First, import the logo file into the
FortiGate unit and then modify the Login page code to reference your file.

To import a logo file:

1. Go to System > Replacement Messages and select Manage Images.
2. Select Create New.
3. Enter a Name for the logo and select the appropriate Content Type.

The file must not exceed 24 Kilo bytes.
4. Select Browse, find your logo file and then select Open.
5. Select OK.

To specify the new logo in the replacement message:

1. Go to Network > Interfaces and edit the interface.
The Security Modemust be Captive Portal.

2. Select the portal message to edit.
l In SSL VPN or WiFi interfaces, in Customize Portal Messages click the link to the portal messages that you

want to edit.
l In other interfaces, make sure that Customize Portal Messages is selected, select the adjacent Edit icon,

then select the message that you want to edit.

3. In the HTML message text, find the %%IMAGE tag.
By default it specifies the Fortinet logo: %%IMAGE:logo_fw_auth%%

4. Change the image name to the one you provided for your logo.
The tag should now read, for example, %%IMAGE:mylogo%%

5. Select Save.
6. Select OK.
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Modifying text in portal messages

Generally, you can change any text that is not part of the HTML code nor a special tag enclosed in double percent
(%) characters. You should not remove any tags because they may carry information that the FortiGate unit
needs. See the preceding section for any exceptions to this rule for particular pages.

To modify portal page text

1. Go to Network > Interfaces and edit the interface.
The SSID Security Modemust be Captive Portal.

2. Select the portal message to edit.
l In SSL VPN or WiFi interfaces, in Customize Portal Messages click the link to the portal messages that you

want to edit.
l In other interfaces, make sure that Customize Portal Messages is selected, select the adjacent Edit icon,

then select the message that you want to edit.

3. Edit the HTML message text, then select Save.
4. Select OK.

Configuring disclaimer page for ethernet interface captive portals

While you can customize a disclaimer page for captive portals that connect via WiFi, the same can be done for
wired connections. However, this can only be configured on the CLI Console, and only without configuring user
groups.

When configuring a captive portal through the CLI, you may set security-groups to a specific user group.
The result of this configuration will show an authentication form to users who wish to log in to the captive portal—
not a disclaimer page. If you do not set any security-groups in your configuration, an "Allow all" status will
be in effect, and the disclaimer page will be displayed for users.

The example CLI configuration below shows setting up a captive portal interface without setting security-groups,
resulting in a disclaimer page for users:

config system interface
edit "port1"

set vdom "root"
set ip 172.16.101.1 255.255.255.0
set allowaccess ping https ssh snmp http
set type physical
set explicit-web-proxy enable
set alias "LAN"
set security-mode captive-portal
set snmp-index 1

next
end
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This section provides an overview of how the FortiGate unit verifies the identities of administrators, SSL VPN
users, or IPsec VPN peers using X.509 security certificates.

The following topics are included in this section:

l What is a security certificate?
l Certificates overview
l Managing X.509 certificates
l Configuring certificate-based authentication
l Support for per-VDOM certificates
l Certificate-based authentication
l Example — Generate and Import CA certificate with private key pair on OpenSSL
l Example — Generate an SSL certificate in OpenSSL

What is a security certificate?
A security certificate is a small text file that is part of a third-party generated public key infrastructure (PKI) to help
guarantee the identity of both the user logging on and the web site they where they are logging in.

A certificate includes identifying information such as the company and location information for the web site, as
well as the third-party company name, the expiry date of the certificate, and the public key.

FortiGate units use X.509 certificates to authenticate single sign-on (SSO) for users. The X.509 standard has
been in use since before 2000, but has gained popularity with the Internet’s increased popularity. X.509 v3 is
defined in RFC 5280 and specifies standard formats for public key certificates, certificate revocation lists, and a
certification path validation algorithm. The unused earlier X.509 version 1 was defined in RFC 1422.

The main difference between X.509 and PGP certificates is that where in PGP anyone can sign a certificate, for
X.509 only a trusted authority can sign certificates. This limits the source of certificates to well known and
trustworthy sources. Where PGP is well suited for one-to-one communications, the X.509 infrastructure is
intended to be used in many different situations including one-to-many communications. Some common
filename extensions for X.509 certificates are listed below.
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Common certificate filename extensions

Filetype Format name Description

.pem Privacy Enhanced Mail (PEM) Base64 encoded DER certificate, that uses:
“-----BEGIN CERTIFICATE-----” and
“-----END CERTIFICATE-----”

.cer

.crt

.der
Security CERtificate Usually binary DER form, but Base64-encoded

certificates are common too.

.p7b

.p7c
Structure without data, just certificates or CRLs.

PKCS#7 is a standard for signing or encrypting
(officially called “enveloping”) data.

.p12 PKCS#12 May contain certificate(s) (public) and private keys
(password protected).

.pfx personal information exchange (PFX) Older format. Came before PKCS#12. Usually today
data is in PKCS#12 format.

Certificates overview
Certificates play a major role in authentication of clients connecting to network services via HTTPS, both for
administrators and SSL VPN users. Certificate authentication is optional for IPsec VPN peers.

This section includes:

l Certificates and protocols
l IPsec VPNs and certificates
l Certificate types on the FortiGate unit

Public CA certificates found on the FortiGate are provided through firmware upgrades
and installations.

Certificates and protocols

There are a number of protocols that are commonly used with certificates including SSL and HTTPS, and other
certificate-related protocols.

SSL and HTTPS

The secure HTTP (HTTPS) protocol uses SSL. Certificates are an integral part of SSL. When a web browser
connects to the FortiGate unit via HTTPS, a certificate is used to verify the FortiGate unit’s identity to the client.
Optionally, the FortiGate unit can require the client to authenticate itself in return.

By default, the FortiGate unit uses a self-signed security certificate to authenticate itself to HTTPS clients. When
the certificate is offered, the client browser displays two security messages.
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l The first message prompts users to accept and optionally install the FortiGate unit’s self-signed security certificate.
If the user does not accept the certificate, the FortiGate unit refuses the connection. When the user accepts the
certificate, the FortiGate login page is displayed, and the credentials entered by the user are encrypted before they
are sent to the FortiGate unit. If the user chooses to install the certificate, the prompt is not displayed again.

l Just before the FortiGate login page is displayed, a second message informs users that the FortiGate certificate
distinguished name differs from the original request. This message is displayed because the FortiGate unit
redirects the connection (away from the distinguished name recorded in the self-signed certificate) and can be
ignored.

Optionally, you can install an X.509 server certificate issued by a certificate authority (CA) on the FortiGate unit.
You can then configure the FortiGate unit to identify itself using the server certificate instead of the self-signed
certificate.

For more information, see the FortiOS Handbook SSL VPN guide.

After successful certificate authentication, communication between the client browser and the FortiGate unit is
encrypted using SSL over the HTTPS link.

Certificate-related protocols

There are multiple protocols that are required for handling certificates. These include the Online Certificate
Status Protocol (OCSP), Secure Certificate Enrollment Protocol (SCEP), and Server-based Certificate Validation
Protocol (SCVP).

Online Certificate Status Protocol

Online Certificate Status Protocol (OCSP) allows the verification of X.509 certificate expiration dates. This is
important to prevent hackers from changing the expiry date on an old certificate to a future date.

Normally certificate revocation lists (CRLs) are used, but OCSP is an alternate method available. However a CRL
is a public list, and some companies may want to avoid the public exposure of their certificate structure even if it
is only invalid certificates.

The OSCP check on the certificate’s revocation status is typically carried out over HTTPwith a request-response
format. The authority responding can reply with a status of good, revoked, or unknown for the certificate in
question.

Secure Certificate Enrollment Protocol

Secure Certificate Enrollment Protocol (SCEP) is an automated method of signing up for certificates. Typically
this involves generating a request you send directly to the SCEP service, instead of generating a file request that
may or may not be signed locally.

Server-based Certificate Validation Protocol

Server-based Certificate Validation Protocol (SCVP) is used to trace a certificate back to a valid root level
certificate. This ensures that each step along the path is valid and trustworthy.

IPsec VPNs and certificates

Certificate authentication is a more secure alternative to preshared key (shared secret) authentication for IPsec
VPN peers. Unlike administrators or SSL VPN users, IPsec peers use HTTP to connect to the VPN gateway
configured on the FortiGate unit. The VPN gateway configuration can require certificate authentication before it
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permits an IPsec tunnel to be established. See Authenticating IPsec VPN users with security certificates on page
489 .

Certificate types on the FortiGate unit

There are different types of certificates available that vary depending on their intended use. FortiOS supports
local, remote, CA, and CRL certificates.

Local certificates

Local certificates are issued for a specific server, or web site. Generally they are very specific, and often for an
internal enterprise network. For example a personal web site for John Smith at www.example.com (such as
http://www.example.com/home/jsmith) would have its own local certificate.

These can optionally be just the certificate file, or also include a private key file and PEM passphrase for added
security.

For information about generating a certificate request, see Generating a certificate signing request on page 479.
For information about installing a local certificate, see Obtaining and installing a signed server certificate from an
external CA on page 481

Remote certificates

Remote certificates are public certificates without a private key. For dynamic certificate revocation, you need to
use an Online Certificate Status Protocol (OCSP) server. The OCSP is configured in the CLI only. Installed
Remote (OCSP) certificates are displayed in the Remote Certificates list. You can select Import to install a
certificate from the management PC.

CA root certificates

CA root certificates are similar to local certificates, however they apply to a broader range of addresses or to
whole company; they are one step higher up in the organizational chain. Using the local certificate example, a CA
root certificate would be issued for all of www.example.com instead of just the smaller single web page.

Certificate revocation list

Certificate revocation list (CRL) is a list of certificates that have been revoked and are no longer usable. This list
includes certificates that have expired, been stolen, or otherwise compromised. If your certificate is on this list, it
will not be accepted. CRLs are maintained by the CA that issues the certificates and includes the date and time
when the next CRL will be issued as well as a sequence number to help ensure you have the most current version
of the CRL.

Certificate signing

The trust in a certificate comes from the authority that signs it. For example if VeriSign signs your CA root
certificate, it is trusted by everyone. While these certificates are universally accepted, it is cumbersome and
expensive to have all certificates on a corporate network signed with this level of trust.

With self-signed certificates nobody, except the other end of your communication, knows who you are and
therefore they do not trust you as an authority. However this level is useful for encryption between two points—
neither point may care about who signed the certificate, just that it allows both points to communicate. This is
very useful for internal networks and communications.
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A general rule is that CA signed certificates are accepted and sometimes required, but it is easier to self-sign
certificates when you are able.

For more on the methods of certificate signing see Generating a certificate signing request on page 479.

BIOS certificate compatibility

FortiOS supports backwards compatibility between BIOS version 4 and BIOS version 3.

BIOS V4 certificates:

l Fortinet_CA
l Fortinet_Sub_CA
l Fortinet_Factory

BIOS V3 certificates:

l Fortinet_CA_Backup
l Fortinet_Factory_Backup

When FortiOS connects to FortiGuard, FortiCloud, FortiManager, FortiAnalyzer, FortiSandbox as a client, the
BIOS certificate Fortinet_Factorywill be the default client certificate. When the server returns its certificate
(chain) back, FortiOS looks up the issuer of the server certificate and either keeps client certificate as is or
switches to the BIOS certificate Fortinet_Factory_Backup. This process occurs in one handshake.

When FortiOS connects to FortiCare, the BIOS certificate Fortinet_Factory is the only client certificate and
Server Name Indication (SNI) is set. There is no switchover of certificate during SSL handshake.

When FortiOS acts as a server when connected by FortiExtender, FortiSwitch, FortiAP, etc., Fortinet_Factory is
the default server certificate. FortiOS detects SNI in client hello, and if no SNI is found or if the CN in SNI is
different from the CN of Fortinet_CA, it switches to use the Fortinet_Factory_Backup.

Managing X.509 certificates
Managing security certificates is required due to the number of steps involved in both having a certificate request
signed, and then distributing the correct files for use.

You use the FortiGate unit or CA software such as OpenSSL to generate a certificate request. That request is a
text file that you send to the CA for verification, or alternately you use CA software to self-validate. Once
validated, the certificate file is generated and must be imported to the FortiGate unit before it can be used. These
steps are explained in more detail later in this section.

This section provides procedures for generating certificate requests, installing signed server certificates, and
importing CA root certificates and CRLs to the FortiGate unit.

For information about how to install root certificates, CRLs, and personal or group certificates on a remote client
browser, refer to your browser’s documentation.

As a requirement of Network Device Collaborative Protection Profile (NDcPP),
FortiOS supports and handles the use of wildcards for the following certificate
reference parameters:

l Subject Alternative Name (SAN)
l Common Name (CN)
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This section includes:

l Generating a certificate signing request
l Generating certificates with CA software
l Obtaining and installing a signed server certificate from an external CA
l Installing a CA root certificate and CRL to authenticate remote clients
l ExtendedKeyUsage for x.509 certificates

Generating a certificate signing request

Whether you create certificates locally with a software application or obtain them from an external certificate
service, you will need to generate a certificate signing request (CSR).

When you generate a CSR, a private and public key pair is created for the FortiGate unit. The generated request
includes the public key of the FortiGate unit and information such as the FortiGate unit’s public static IP address,
domain name, or email address. The FortiGate unit’s private key remains confidential on the FortiGate unit.

After you submit the request to a CA, the CAwill verify the information and register the contact information on a
digital certificate that contains a serial number, an expiration date, and the public key of the CA. The CAwill then
sign the certificate, and you install the certificate on the FortiGate unit.

The Certificate Request Standard is a public key cryptography standard (PKCS) published by RSA, specifically
PKCS10 which defines the format for CSRs. This is defined in RFC 2986.

To generate a certificate request in FortiOS - web-based manager:

1. Go to System > Certificates.
2. Select Generate.
3. In the Certificate Name field, enter a unique meaningful name for the certificate request. Typically, this would be

the hostname or serial number of the FortiGate unit or the domain of the FortiGate unit such as example.com.

Do not include spaces in the certificate name. This will ensure compatibility of
a signed certificate as a PKCS12 file to be exported later on if required.

Prior to FortiOS 5.4, passwords for local certificates that were generated via either
SCEP or CLI could not have their passwords reset. Passwords can be set in the CLI
using the following command:

config vpn certificate local
edit <name>

set password <password>
next

end

4. Enter values in the Subject Information area to identify the FortiGate unit:
l If the FortiGate unit has a static IP address, select Host IPand enter the public IP address of the FortiGate

unit. If the FortiGate unit does not have a public IP address, use an email address (or fully qualified domain
name (FQDN) if available) instead.
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l If the FortiGate unit has a dynamic IP address and subscribes to a dynamic DNS service, use a FQDN if
available to identify the FortiGate unit. If you select Domain Name, enter the FQDN of the FortiGate unit. Do
not include the protocol specification (http://) or any port number or path names.

If a domain name is not available and the FortiGate unit subscribes to a
dynamic DNS service, an “unable to verify certificate” type message may be
displayed in the user’s browser whenever the public IP address of the
FortiGate unit changes.

l If you select E-Mail, enter the email address of the owner of the FortiGate unit.

5. Enter values in theOptional Information area to further identify the FortiGate unit.

Organization Unit Name of your department. You can enter a series of OUs up to a maximum
of 5. To add or remove an OU, use the plus (+) or minus (-) icon.

Organization Legal name of your company or organization.

Locality (City) Name of the city or town where the FortiGate unit is installed.

State/Province Name of the state or province where the FortiGate unit is installed.

Country Select the country where the FortiGate unit is installed.

e-mail Contact email address.

Subject Alternative Name Optionally, enter one or more alternative names for which the certificate is
also valid. Separate names with a comma. A name can be:

l e-mail address
l IP address
l URI
l DNS name (alternatives to the Common Name)
l directory name (alternatives to the Distinguished Name)

You must precede the name with the name type. Examples:

IP:1.1.1.1
email:test@fortinet.com
email:my@other.address
URI:http://my.url.here/

Password for private key Option to export local certificate and its private key in password protected
p12.

6. From the Key Type list, select RSA or Elliptic Curve.
7. From the Key Size list, select 1024 Bit, 1536 Bit, 2048 Bit, 4096 Bit or secp256r1, secp384r1, secp521r1

respectively. Larger keys are slower to generate but more secure.
8. In Enrollment Method, you have two methods to choose from. Select File Based to generate the certificate

request, orOnline SCEP to obtain a signed SCEP-based certificate automatically over the network. For the
SCEPmethod, enter the URL of the SCEP server from which to retrieve the CA certificate, and the CA server
challenge password.

9. Select OK.
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10. The request is generated and displayed in the Local Certificates list with a status of PENDING.
11. Select the Download button to download the request to the management computer.
12. In the File Download dialog box, select Save and save the Certificate Signing Request on the local file system of

the management computer.
13. Name the file and save it on the local file system of the management computer.
The certificate request is ready for the certificate authority to be signed.

Generating certificates with CA software

CA software allows you to generate unmanaged certificates and CA certificates for managing other certificates
locally without using an external CA service. Examples of CA software include ssl-ca from OpenSSL (available for
Linux, Windows, and Mac) or gensslcert from SuSE, MSWindows Server 2000 and 2003 come with a CA as part
of their certificate services, and in MSWindows 2008 CA software can be installed as part of the Active Directory
installation. See Example — Generate and Import CA certificate with private key pair on OpenSSL on page 492.

The general steps for generating certificates with CA software are

1. Install the CA software as a stand-alone root CA.
2. Provide identifying information for your self-administered CA.
While following these steps, the methods vary slightly when generating server certificates, CA certificates, and
PKI certificates.

Server certificate

1. Generate a Certificate Signing Request (CSR) on the FortiGate unit.
2. Copy the CSR base-64 encoded text (PKCS10 or PKCS7) into the CA software and generate the certificate.

PKCS10 is the format used to send the certificate request to the signing authority. PKCS7 is the format the signing
authority can use for the newly signed certificate.

3. Export the certificate as a X.509 DER encoded binary file with .CER extension
4. Upload the certificate file to the FortiGate unit Local Certificates page (type is Certificate).

CA certificate

1. Retrieve the CACertificate from the CA software as a DER encoded file.
2. Import the CA certificate file to the FortiGate unit at System > Certificates and select Import > Certificates.

PKI certificate

1. Generate a Certificate Signing Request (CSR) on the FortiGate unit.
2. Copy the CSR base-64 encoded text (PKCS#10 or PKCS#7) into the CA software and generate the certificate.

PKCS10 is the format used to send the certificate request to the signing authority. PKCS7 is the format the signing
authority can use for the newly signed certificate.

3. Export the certificate as a X.509 DER encoded binary file with .CER extension.
4. Install the certificate in the user’s web browser or IPsec VPN client as needed.

Obtaining and installing a signed server certificate from an external CA

To obtain a signed server certificate for a FortiGate unit, you must send a request to a CA that provides digital
certificates that adhere to the X.509 standard. The FortiGate unit provides a way for you to generate the request.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

481



Certificate-based authentication

To submit the certificate signing request (file-based enrollment):

1. Using the web browser on the management computer, browse to the CAweb site.
2. Follow the CA instructions for a base-64 encoded PKCS#10 certificate request and upload your certificate request.
3. Follow the CA instructions to download their root certificate and CRL.

When you receive the signed server certificate from the CA, install the certificate on the FortiGate unit.

To install or import the signed server certificate - web-based manager

1. On the FortiGate unit, go to System > Certificates and select Import > Local Certificates.
2. From Type, select Local Certificate.
3. Select Browse, browse to the location on the management computer where the certificate was saved, select the

certificate, and then select Open.
4. Select OK, and then select Return.

Installing a CA root certificate and CRL to authenticate remote clients

When you apply for a signed personal or group certificate to install on remote clients, you can obtain the
corresponding root certificate and CRL from the issuing CA. When you receive the signed personal or group
certificate, install the signed certificate on the remote client(s) according to the browser documentation. Install
the corresponding root certificate (and CRL) from the issuing CA on the FortiGate unit according to the
procedures given below.

To install a CA root certificate

1. After you download the root certificate of the CA, save the certificate on the management computer. Or, you can
use online SCEP to retrieve the certificate.

2. On the FortiGate unit, go to System > Certificates and select Import > CA Certificates.
3. Do one of the following:

l To import using SCEP, select SCEP. Enter the URL of the SCEP server from which to retrieve the CA
certificate. Optionally, enter identifying information of the CA, such as the filename.

l To import from a file, select Local PC, then select Browse and find the location on the management
computer where the certificate has been saved. Select the certificate, and then select Open.

5. Select OK, and then select Return.
The system assigns a unique name to each CA certificate. The names are numbered consecutively (CA_Cert_1,
CA_Cert_2, CA_Cert_3, and so on).

To import a certificate revocation list

ACertificate Revocation List (CRL) is a list of the CA certificate subscribers paired with certificate status
information. The list contains the revoked certificates and the reason(s) for revocation. It also records the
certificate issue dates and the CAs that issued them.

When configured to support SSL VPNs, the FortiGate unit uses the CRL to ensure that the certificates belonging
to the CA and remote peers or clients are valid. The CRL has an “effective date” and a “next update” date. The
interval is typically 7 days (for Microsoft CA). FortiOS will update the CRL automatically. Also, there is a CLI
command to specify an “update-interval” in seconds. Recommendation should be 24 hours (86400 seconds) but
depends on company security policy.

482 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Certificate-based authentication

1. After you download the CRL from the CAweb site, save the CRL on the management computer.
2. Go to System > Certificates and select Import > CRL.
3. Do one of the following:

l To import using an HTTP server, select HTTP and enter the URL of the HTTP server.
l To import using an LDAP server see this KB article.
l To import using an SCEP server, select SCEP and select the Local Certificate from the list. Enter the URL of

the SCEP server from which the CRL can be retrieved.
l To import from a file, select Local PC, then select Browse and find the location on the management

computer where the CRL has been saved. Select the CRL and then select Open.

5. Select OK, and then select Return.

To import a PKCS12 certificate from the CLI

The following CLI syntax can be entered to import a local certificate file:

execute vpn certificate local import tftp <file name> <tftp ip address> <file type> <Enter
for 'cer'>|<password for 'p12'>

For example:

execute vpn certificate local import tftp FGTF-extern.p12 10.1.100.253 p12 123456

In addition, the following CLI syntax can be entered to update certificate bundles from an FTP or TFTP server:

execute vpn certificate ca import bundle <file-name.pkg> <ftp/tftp-server-ip>

ExtendedKeyUsage for x.509 certificates

As per Network Device Collaborative Protection Profile (NDcPP) v1.0 requirements, server certificates used for
TLS connections between FortiGate and FortiAnalyzer have the "Server Authentication" and "Client
Authentication" extendedKeyUsage fields in FIPS/CC mode.

The following CLI command is available under log fortianalyzer setting to allow you to specify the
certificate used to communicate with FortiAnalyzer.

CLI syntax

config log fortianalyzer setting
set certificate <name>

end

Troubleshooting certificates
There are times when there are problems with certificates— a certificate is seen as expired when its not, or it
can’t be found. Often the problem is with a third party web site, and not FortiOS. However, some problems can
be traced back to FortiOS such as DNS or routing issues.

Enable and disable SHA1 algorithm in SSH key exchanges

In order to investigate your security and conduct compliance testing, a global option allows you to enable/disable
SHA1 algorithm in SSH key exchange. Note that, the algorithm is enabled by default.
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Syntax

config system global
set ssh-key-sha1 {enable | disable}

end

Certificate is reported as expired when it is not

Certificates often are issued for a set period of time such as a day or a month, depending on their intended use.
This ensures everyone is using up-to-date certificates. It is also more difficult for hackers to steal and use old
certificates.

Reasons a certificate may be reported as expired include:

l It really has expired based on the “best before” date in the certificate
l The FortiGate unit clock is not properly set. If the FortiGate clock is fast, it will see a certificate as expired before

the expiry date is really here.
l The requesting server clock is not properly set. A valid example is if your certificate is 2 hours from expiring, a server

more than two time zones away would see the certificate as expired. Otherwise, if the server’s clock is set wrongly it
will also have the same effect.

l The certificate was revoked by the issuer before the expiry date. This may happen if the issuer believes a certificate
was either stolen or misused. Its possible it is due to reasons on the issuer’s side, such as a system change or such.
In either case it is best to contact the certificate issuer to determine what is happening and why.

A secure connection cannot be completed (Certificate cannot be found)

Everyone who uses a browser has encountered a message such as This connection is untrusted. Normally when
you try to connect securely to a web site, that web site will present its valid certificate to prove their identity is
valid. When the web site's certificate cannot be verified as valid, the message appears stating This connection is
untrusted or something similar. If you usually connect to this web site without problems, this error could mean
that someone is trying to impersonate or hijack the web site, and best practices dictates you not continue.

Reasons a web site’s certificate cannot be validated include:

l The web site uses an unrecognized self-signed certificate. These are not secure because anyone can sign them. If
you accept self-signed certificates you do so at your own risk. Best practices dictate that you must confirm the ID of
the web site using some other method before you accept the certificate.

l The certificate is valid for a different domain. A certificate is valid for a specific location, domain, or sub-section of a
domain such as one certificate for support.example.com that is not valid for marketing.example.com. If
you encounter this problem, contact the webmaster for the web site to inform them of the problem.

l There is a DNS or routing problem. If the web site’s certificate cannot be verified, it will not be accepted. Generally
to be verified, your system checks with the third party certificate signing authority to verify the certificate is valid. If
you cannot reach that third party due to some DNS or routing error, the certificate will not be verified.

l Firewall is blocking required ports. Ensure that any firewalls between the requesting computer and the web site
allow the secure traffic through the firewall. Otherwise a hole must be opened to allow it through. This includes
ports such as 443 (HTTPS) and 22 (SSH).

Online updates to certificates and CRLs

If you obtained your local or CA certificate using SCEP, you can configure online renewal of the certificate before
it expires. Similarly, you can receive online updates to CRLs.
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Local certificates

In the config vpn certificate local command, you can specify automatic certificate renewal. The
relevant fields are:

scep-url <URL_str> The URL of the SCEP server. This can be HTTP or HTTPS. The
following options appear after you add the <URL_str>.

scep-password <password_str> The password for the SCEP server.

auto-regenerate-days <days_
int>

Howmany days before expiry the FortiGate unit requests an
updated local certificate. The default is 0, no auto-update.

auto-regenerate-days-warning
<days_int>

Howmany days before local certificate expiry the FortiGate
generates a warning message. The default is 0, no warning.

In this example, an updated certificate is requested three days before it expires.

config vpn certificate local
edit mycert

set scep-url http://scep.example.com/scep
set scep-server-password my_pass_123
set auto-regenerate-days 3
set auto-regenerate-days-warning 2

end

CA certificates

In the config vpn certificate ca command, you can specify automatic certificate renewal. The
relevant fields are:

Variable Description

scep-url <URL_str> The URL of the SCEP server. This can be HTTP or HTTPS.

auto-update-days <days_int> Howmany days before expiry the FortiGate unit requests an
updated CA certificate. The default is 0, no auto-update.

auto-update-days-warning
<days_int>

Howmany days before CA certificate expiry the FortiGate
generates a warning message. The default is 0,no warning.

In this example, an updated certificate is requested three days before it expires.

config vpn certificate ca
edit mycert

set scep-url http://scep.example.com/scep
set auto-update-days 3
set auto-update-days-warning 2

end
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Certificate Revocation Lists

If you obtained your CRL using SCEP, you can configure online updates to the CRL using the config vpn
certificate crl command. The relevant fields are:

Variable Description

http-url <http_url> URL of the server used for automatic CRL certificate updates.
This can be HTTP or HTTPS.

scep-cert <scep_certificate> Local certificate used for SCEP communication for CRL auto-
update.

scep-url <scep_url> URL of the SCEPCA server used for automatic CRL certificate
updates. This can be HTTP or HTTPS.

update-interval <seconds>
How frequently, in seconds, the FortiGate unit checks for an
updated CRL. Enter 0 to update the CRL only when it expires.
Not available for http URLs.

update-vdom <update_vdom> VDOM used to communicate with remote SCEP server for CRL
auto-update.

In this example, an updated CRL is requested only when it expires.

config vpn certificate crl
edit cert_crl

set http-url http://scep.example.com/scep
set scep-cert my-scep-cert
set scep-url http://scep.ca.example.com/scep
set update-interval 0
set update-vdom root

end

Backing up and restoring local certificates

The FortiGate unit provides a way to export and import a server certificate and the FortiGate unit’s personal key
through the CLI. If required (to restore the FortiGate unit configuration), you can import the exported file through
the System > Certificates page of the web-based manager.

As an alternative, you can back up and restore the entire FortiGate configuration
through the System Information widget on the Dashboard of the web-based
manager. Look for [Backup] and [Restore] in the System Configuration row. The
backup file is created in a FortiGate-proprietary format.

To export a server certificate and private key - CLI:

This procedure exports a server (local) certificate and private key together as a password protected PKCS12 file.
The export file is created through a customer-supplied TFTP server. Ensure that your TFTP server is running and
accessible to the FortiGate unit before you enter the command.

1. Connect to the FortiGate unit through the CLI.
2. Type the following command:
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execute vpn certificate local export tftp <cert_name> <exp_filename> <tftp_ip>
<password>

where:

l <cert_name> is the name of the server certificate; typing ? displays a list of installed server certificates.
l <exp_filename> is a name for the output file.
l <tftp_ip> is the IP address assigned to the TFTP server host interface.

3. Move the output file from the TFTP server location to the management computer for future reference.

To import a server certificate and private key - web-based manager:

1. Go to System > Certificates and select Import.
2. In Type, select PKCS12 Certificate.
3. Select Browse. Browse to the location on the management computer where the exported file has been saved,

select the file, and then select Open.
4. In the Password field, type the password needed to upload the exported file.
5. Select OK, and then select Return.

To import a server certificate and private key - CLI:

1. Connect to the FortiGate unit through the CLI.
2. Type the following command:

execute vpn certificate local import tftp <file_name> <tftp_ip_address> <file_type> <Enter
for 'cer'>|<password for 'p12'>

For example:

execute vpn certificate local import tftp FGTF-extern.p12 10.1.100.253 p12 123456

To import separate server certificate and private key files - web-based manager

Use the following procedure to import a server certificate and the associated private key file when the server
certificate request and private key were not generated by the FortiGate unit. The two files to import must be
available on the management computer.

1. Go to System > Certificates and select Import.
2. In Type, select Certificate.
3. Select the Browse button beside the Certificate file field. Browse to the location on the management computer

where the certificate file has been saved, select the file, and then select Open.
4. Select the Browse button beside the Key file field. Browse to the location on the management computer where

the key file has been saved, select the file, and then select Open.
5. If required, in the Password field, type the associated password, and then select OK.
6. Select Return.

Configuring certificate-based authentication
You can configure certificate-based authentication for FortiGate administrators, SSL VPN users, and IPsec VPN
users.
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In Microsoft Windows 7, you can use the certificate manager to keep track of all the different certificates on your
local computer. To access certificate manager, in Windows 7 press the Windows key, enter “certmgr.msc” at the
search prompt, and select the displayed match. Remember that in addition to these system certificates, many
applications require you to register certificates with them directly.

To see FortiClient certificates, open the FortiClient Console, and select VPN. The VPNmenu has options for My
Certificates (local or client) and CACertificates (root or intermediary certificate authorities). Use Import on those
screens to import certificate files from other sources.

Authenticating administrators with security certificates

You can install a certificate on the management computer to support strong authentication for administrators.
When a personal certificate is installed on the management computer, the FortiGate unit processes the
certificate after the administrator supplies a username and password.

To enable strong administrative authentication:

l Obtain a signed personal certificate for the administrator from a CA and load the signed personal certificate into the
web browser on the management computer according to the browser documentation.

l Install the root certificate and the CRL from the issuing CA on the FortiGate unit (see Installing a CA root certificate
and CRL to authenticate remote clients on page 482 ).

l Create a PKI user account for the administrator.
l Add the PKI user account to a firewall user group dedicated to PKI-authenticated administrators.
l In the administrator account configuration, select PKI as the account Type and select the User Group to which

the administrator belongs.

Support exact match for subject and CN fields in peer user

In order to avoid any unintentional admin access by regular users, administrators can specify which way a peer
user authenticates.

When searching for a matching certificate, use the commands below to control how to find matches in the
certificate subject name (subject-match) or the cn attribute (cn-match) of the certificate subject name. This
match can be any string (substring) or an exact match (value) of the cn attribute value.

To determine certificate subject name matches - CLI:

config vpn certificate setting
edit <name>

set subject-match {substring | value}
set cn-match {substring | value}

next
end

Authenticating SSL VPN users with security certificates

While the default self-signed certificates can be used for HTTPS connections, it is preferable to use the X.509
server certificate to avoid the redirection as it can be misinterpreted as possible session hijacking. However, the
server certificate method is more complex than self-signed security certificates. Also the warning message is
typically displayed for the initial connection, and future connections will not generate these messages.

X.509 certificates can be used to authenticate IPsec VPN peers or clients, or SSL VPN clients. When configured
to authenticate a VPN peer or client, the FortiGate unit prompts the VPN peer or client to authenticate itself using
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the X.509 certificate. The certificate supplied by the VPN peer or client must be verifiable using the root CA
certificate installed on the FortiGate unit in order for a VPN tunnel to be established.

To enable certificate authentication for an SSL VPN user group:

1. Install a signed server certificate on the FortiGate unit and install the corresponding root certificate (and CRL)
from the issuing CA on the remote peer or client.

2. Obtain a signed group certificate from a CA and load the signed group certificate into the web browser used by
each user. Follow the browser documentation to load the certificates.

3. Install the root certificate and the CRL from the issuing CA on the FortiGate unit (see Installing a CA root
certificate and CRL to authenticate remote clients on page 482).

4. Create a PKI user for each SSL VPN user. For each user, specify the text string that appears in the Subject field of
the user’s certificate and then select the corresponding CA certificate.

5. Use the config user peergrp CLI command to create a peer user group. Add to this group all of the SSL
VPN users who are authenticated by certificate.

6. Go to Policy & Objects > IPv4 Policy.
7. Edit the SSL-VPN security policy.
8. Select the user group created earlier in the Source User(s) field.
9. Select OK.

Authenticating IPsec VPN users with security certificates

To require VPN peers to authenticate by means of a certificate, the FortiGate unit must offer a certificate to
authenticate itself to the peer.

To enable the FortiGate unit to authenticate itself with a certificate:

1. Install a signed server certificate on the FortiGate unit.
See To install or import the signed server certificate - web-based manager on page 482.

2. Install the corresponding CA root certificate on the remote peer or client. If the remote peer is a FortiGate unit,
see To install a CA root certificate on page 482.

3. Install the certificate revocation list (CRL) from the issuing CA on the remote peer or client. If the remote peer is a
FortiGate unit, see To import a certificate revocation list on page 482.

4. In the VPN phase 1 configuration, set Authentication Method to Signature and from the Certificate Name list
select the certificate that you installed in Step 1.

To authenticate a VPN peer using a certificate, you must install a signed server certificate on the peer. Then, on
the FortiGate unit, the configuration depends on whether there is only one VPN peer or if this is a dialup VPN that
can be multiple peers.

To configure certificate authentication of a single peer

1. Install the CA root certificate and CRL.
2. Create a PKI user to represent the peer. Specify the text string that appears in the Subject field of the user’s

certificate and then select the corresponding CA certificate.
3. In the VPN phase 1 Peer Options, select peer certificate forAccept Types field and select the PKI user that

you created in the Peer certificate field.
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To configure certificate authentication of multiple peers (dialup VPN)

1. Install the corresponding CA root certificate and CRL.
2. Create a PKI user for each remote VPN peer. For each user, specify the text string that appears in the Subject field

of the user’s certificate and then select the corresponding CA certificate.
3. Use the config user peergrp CLI command to create a peer user group. Add to this group all of the PKI

users who will use the IPsec VPN.
In the VPN phase 1 Peer Options, select peer certificate group forAccept Types field and select the PKI
user group that you created in the Peer certificate group field.

Support for per-VDOM certificates
The CA and local certificate configuration is available per-VDOM. When an admin uploads a certificate to a
VDOM, it will only be accessible inside that VDOM. When an admin uploads a certificate to global, it will be
accessible to all VDOMs and global.

There are factory default certificates such as Fortinet_CA_SSL, Fortinet_SSL, Fortinet_Wifi, and Fortinet_
Factory. These certificates are moved to per-VDOM and automatically generated when a new VDOM is created.

The Fortinet_Firmware certificate has been removed and all the attributes that use
Fortinet_Firmware now use Fortinet_Factory.

CLI Changes

Two new attributes range and source have been added:

range can be global or per-VDOM, if the certificate file is imported from global, it is a global certificate. If the
certificate file is imported from a VDOM, it is VDOM certificate.

source can be either factory, user, or fortiguard:

l factory: The factory certificate file with FortiOS version, this includes: Fortinet_CA_SSL, Fortinet_SSL,
PositiveSSL_CA, Fortinet_Wifi, Fortinet_Factory.

l user: Certificate file imported by the user.
l fortiguard: Certificate file imported from FortiGuard.

config certificate local
edit Fortinet_Factory

set range {global | vdom}
set source {factory | user | fortiguard}

end
end

GUI Changes

Global and new VDOMs have the following factory default certificates:
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These certificates are created automatically when a new VDOM is created, with every VDOM having its own
versions of these certificates.

Example — Generate a CSR on the FortiGate unit
This example follows all the steps required to create and install a local certificate on the FortiGate unit, without
using CA software.

The FortiGate unit is called myFortiGate60, and is located at 10.11.101.101 (a private IP address) and
http://myfortigate.example.com. Mr. John Smith (john.smith@myfortigate.example.com) is the IT administrator
for this FortiGate unit, and the unit belongs to the Sales department located in Greenwich, London, England.

To generate a certificate request on the FortiGate unit - web-based manager:

1. Go to System > Certificates.
2. Select Generate.
3. In the Certificate Name field, enter myFortiGate60.

Do not include spaces in the certificate name. This will ensure compatibility of a
signed certificate as a PKCS12 file to be exported later on if required.

Since the IP address is private, we will use the FQDN instead.

4. Select Domain Name, and enter http://myfortigate.example.com.
5. Enter values in theOptional Information area to further identify the FortiGate unit.

Organization Unit Sales

Organization Example.com

Locality (City) Greenwich

State/Province London

Country England

e-mail john.smith@myfortigate.example.com
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6. From the Key Type list, select RSA or Elliptic Curve.
7. If RSA is selected, from the Key Size list, select 2048 Bit. If Elliptic Curve is selected,from the Curve Name list,

select secp256r1.
8. In Enrollment Method, select File Based to generate the certificate request
9. Select OK.

The request is generated and displayed in the Local Certificates list with a status of PENDING.
10. Select the Download button to download the request to the management computer.
11. In the File Download dialog box, select Save and save the Certificate Signing Request on the local file system

of the management computer.
12. Name the file and save it on the local file system of the management computer.

Example — Generate and Import CA certificate with private key pair on OpenSSL
This example explains how to generate a certificate using OpenSSL on MSWindows. OpenSSL is available for
Linux and Mac OS as well, however their terminology will vary slightly from what is presented here.

Assumptions

Before starting this procedure, ensure that you have downloaded and installed OpenSSL on Windows. One
source is: http://www.slproweb.com/products/Win32OpenSSL.html.

Generating and importing the CA certificate and private key

The two following procedures will generate a CA certificate file and private key file, and then import it to the
FortiGate unit as a local certificate.

To generate the private key and certificate

1. At the Windows command prompt, go to the OpenSSL bin directory. If you installed to the default location this will
be the command:

cd c:\OpenSSL-Win32\bin

2. Enter the following command to generate the private key. You will be prompted to enter your PEM pass phrase.
Choose something easy to remember such as fortinet123.

openssl genrsa -aes256 -out fgtcapriv.key 2048

This command generates an RSA AES256 2048-bit encryption key.

3. The following command will generate the certificate using the key from the previous step.

openssl req -new -x509 -days 3650 -extensions v3_ca -key fgtcapriv.key -out
fgtca.crt

This step generates an X509 CA certificate good for 10 years that uses the key generated in the
previous step. The certificate filename is fgtca.crt.

You will be prompted to enter information such as PEM Pass Phrase from the previous step, Country
Name, State, Organization Name, Organizational Unit (such as department name), Common Name
(the FQDN), and Email Address.
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To import the certificate to the FortiGate unit - web-based manager:

1. Go to System > Certificates.
2. Select Import > Local Certificate.
3. Select Certificate for Type.

Fields for Certificate file, Key file, and Password are displayed.
4. For Certificate file, enter c:\OpenSSL-Win32\bin\fgtca.crt.
5. ForKey file, enter c:\OpenSSL-Win32\bin\fgtcapriv.key.
6. For Password, enter the PEM Pass Phrase you entered earlier, such as fortinet123.
7. Select OK.
The Certificate will be added to the list of Local Certificates and be ready for use. It will appear in the list as the
filename you uploaded— fgtca.You can add comments to this certificate to make it clear where its from and
how it is intended to be used. If you download the certificate from FortiOS, it is a .CER file.

It can now be used in Authenticating IPsec VPN users with security certificates on page 489, and Authenticating
SSL VPN users with security certificates on page 488.

Example — Generate an SSL certificate in OpenSSL
This example explains how to generate a CA signed SSL certificate using OpenSSL on MSWindows. OpenSSL is
available for Linux and Mac OS as well, however their terminology will vary slightly from what is presented here.

In this example, you will:

l Generate a CA signed SSL certificate
l Generate a self-signed SSL certificate
l Import the SSL certificate into FortiOS

Assumptions

l Before starting this procedure, ensure that you have downloaded and installed OpenSSL on MSWindows. One
download source is http://www.slproweb.com/products/Win32OpenSSL.html.

Generating a CA signed SSL certificate

This procedure assumes that you have already completed Example — Generate and Import CA certificate with
private key pair on OpenSSL on page 492 successfully.

To generate the CA signed SSL certificate:

1. At the Windows command prompt, go to the OpenSSL bin directory. If you installed to the default location this will
be the following command:

cd c:\OpenSSL-Win32\bin

2. Enter the following command to generate the private key. You will be prompted to enter your PEM pass phrase.
Choose something easy to remember such as fortinet.

openssl genrsa -aes256 -out fgtssl.key 2048

This command generates an RSA AES256 2048-bit encryption key.
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3. Create a certificate signing request for the SSL certificate. This step requires you to enter the information listed in
step 3 of the previous example — To generate the private key and certificate. You can leave the Challenge
Password blank.

openssl req -new -sha256 -key fgtssl.key -out fgtssl.csr

Most Certificate Authorities will ignore the value that is set in the CSR and use
whatever value they are set to use in their configuration. This means that the client will
likely need to modify their openssl.conf file to use SHA-256 (or another SHA-2 variant).

4. Using the CSR from the previous step, you can now create the SSL certificate using the CA certificate that was
created in Example — Generate and Import CA certificate with private key pair on OpenSSL.

openssl x509 -req -days 365 -in fgtssl.csr -CA fgtca.crt -CAkey fgtcapriv.key -set_
serial 01 -out fgtssl.crt

This will generate an X.509 certificate good for 365 days signed by the CA certificate fgtca.crt.

Generating a self-signed SSL certificate

This procedures does not require any existing certificates.

1. At the Windows command prompt, go to the OpenSSL bin directory. If you installed to the default location this will
be the following command:

cd c:\OpenSSL-Win32\bin

2. Enter the following command to generate the private key. You will be prompted to enter your PEM pass phrase.
Choose something easy to remember such as fortinet.

openssl genrsa -aes256 -out fgtssl.key 2048
openssl req -new -key fgtssl.key -out fgtssl.csr
openssl x509 -req -days 365 -in fgtssl.csr -signkey fgtssl.key -out fgtssl.crt

These commands:

l generate an RSA AES256 2048-bit private key,
l generate an SSL certificate signing request, and
l sign the CSR to generate an SSL .CRT certificate file.

Import the SSL certificate into FortiOS

To import the certificate to FortiOS- web-based manager

1. Go to System > Certificates.
2. Select Import > Local Certificate.
3. Select Certificate for Type.

Fields for Certificate file, Key file, and Password are displayed.
4. For Certificate file, enter c:\OpenSSL-Win32\bin\fgtssl.crt.
5. ForKey file, enter c:\OpenSSL-Win32\bin\fgtssl.key.
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6. For Password, enter the PEM Pass Phrase you entered, such as fortinet.
7. Select OK.
The SSL certificate you just uploaded can be found under System > Certificates under the name of the file you
uploaded— fgtssl.

To confirm the certificate is uploaded properly - CLI:

config vpn certificate local
edit fgtssl

get
end

The get command will display all the certificate’s information. If it is not there or the information is not correct,
you will need to remove the corrupted certificate (if it is there) and upload it again from your PC.

To use the new SSL certificate - CLI

config vpn ssl settings
set servercert fgtssl

end

This assigns the fgtssl certificate as the SSL server certificate. For more information see the FortiOS Handbook
SSL VPN guide.
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If you use a FortiAuthenticator unit in your network as a single sign-on agent,

l Users can authenticate through a web portal on the FortiAuthenticator unit.
l Users with FortiClient Endpoint Security installed can be automatically authenticated by the FortiAuthenticator unit

through the FortiClient SSO Mobility Agent.

The FortiAuthenticator unit can integrate with external network authentication systems such as RADIUS and
LDAP to gather user logon information and send it to the FortiGate unit.

User’s view of FortiAuthenticator SSO authentication
There are two different ways users can authenticate through a FortiAuthenticator unit.

Users without FortiClient Endpoint Security - SSO widget

To log onto the network, the user accesses the organization’s web page with a web browser. Embedded on that
page is a simple logon widget, like this:

User not logged in. Click Login to go to the FortiAuthenticator login page.

User logged in. Name displayed. Logout button available.

The SSO widget sets a cookie on the user’s browser. When the user browses to a page containing the login
widget, the FortiAuthenticator unit recognizes the user and updates its database if the user’s IP address has
changed. The user will not need to re-authenticate until the login timeout expires, which can be up to 30 days.

Users with FortiClient Endpoint Security - FortiClient SSO Mobility Agent

The user simply accesses resources and all authentication is performed transparently with no request for
credentials. IP address changes, such as those due to WiFi roaming, are automatically sent to the
FortiAuthenticator unit. When the user logs off or otherwise disconnects from the network, the FortiAuthenticator
unit is aware of this and deauthenticates the user.

The FortiClient SSO Mobility Agent, a feature of FortiClient Endpoint Security v5.0, must be configured to
communicate with the appropriate FortiAuthenticator unit. After that, the agent automatically provides user name
and IP address information to the FortiAuthenticator unit for transparent authentication.

Administrator’s view of FortiAuthenticator SSO authentication
You can configure either or both of these authentication types on your network.

SSO widget

You need to configure the Single Sign-On portal on the FortiAuthenticator unit. Go to Fortinet SSO Methods >
SSO > Portal Services to do this. Copy the Embeddable login widget code for use on your organization’s
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home page. Identity-based security policies on the FortiGate unit determine which users or groups of users can
access which network resources.

FortiClient SSO Mobility Agent

Your users must be running at least FortiClient Endpoint Security v5.0 to make use of this type of authentication.

On the FortiAuthenticator unit, you need to select Enable FortiClient SSO Mobility Agent Service, optionally
select Enable Authentication and choose a Secret key. Go to Fortinet SSO Methods > SSO > General.
You need to provide your users the FortiAuthenticator IP address and secret key so that they can configure the
FortiClient SSO Mobility Agent on their computers. See Configuring the FortiGate unit on page 498.

Configuring the FortiAuthenticator unit
The FortiAuthenticator unit can poll FortiGate units, Windows Active Directory, RADIUS servers, LDAP servers,
and FortiClients for information about user logon activity.

To configure FortiAuthenticator polling:

1. Go to Fortinet SSO Methods > SSO > General.
2. In the FortiGate section, leave the Listening port at 8000, unless your network requires you to change this. The

FortiGate unit must allow traffic on this port to pass through the firewall.
Optionally, you can set the Login Expiry time. This is the length of time users can remain logged in before the
system logs them off automatically. The default is 480 minutes (8 hours).

3. Select Enable Authentication and enter the Secret key. Be sure to use the same secret key when configuring
the FSSO Agent on FortiGate units.

4. In the Fortinet Single Sign-On (FSSO) section, enter

Enable Windows Active
Directory domain
controllers

Select for integration with Windows Active Directory.

Enable Radius accounting
SSO clients

Select if you want to use a Remote Radius server.

Enable Syslog SSO Select for integration with Syslog server.

Enable FortiClient SSO
Mobility Agent service

Enable Authentication

Select both options to enable single sign-on by clients running FortiClient
Endpoint Security. Enter the Secret key. Be sure to use the same secret
key in the FortiClient Single Sign-On Mobility Agent settings.

5. Select OK.
For more information, see the FortiAuthenticator Administration Guide.
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Configuring the FortiGate unit

Adding a FortiAuthenticator unit as an SSO agent

On the FortiGate unit, you need to add the FortiAuthenticator unit as a Single Sign-On agent that provides user
logon information.

To add a FortiAuthenticator unit as SSO agent:

1. Go to User & Device > Single Sign-On and select Create New.
2. In Type, select Fortinet Single-Sign-On Agent.
3. Enter a Name for the FortiAuthenticator unit.
4. In Primary Agent IP/Name, enter the IP address of the FortiAuthenticator unit.
5. In Password, enter the secret key that you defined for the FortiAuthenticator unit.

On the FortiAuthenticator unit, you go to Fortinet SSO Methods > SSO > General to define the secret key.
Select Enable Authentication.

6. Select OK.
In a few minutes, the FortiGate unit receives a list of user groups from the FortiAuthenticator unit. The entry in
the Single Sign-On server list shows a blue caret.

When you open the server, you can see the list of groups. You can use the groups in identity-based security
policies.

Configuring an FSSO user group

You cannot use FortiAuthenticator SSO user groups directly in a security policy. Create an FSSO user group and
add FortiAuthenticator SSO user groups to it. FortiGate FSSO user groups are available for selection in identity-
based security policies.

To create an FSSO user group:

1. Go to User & Device > User Groups and select Create New.
2. Enter a Name for the group.
3. In Type, select Fortinet Single Sign-On (FSSO).
4. AddMembers.

The groups available to add as members are SSO groups provided by SSO agents.
5. Select OK.

Configuring security policies

You can create identity-based policies based on FSSO groups as you do for local user groups. For more
information about security policies see the Firewall chapter.
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Configuring the FortiClient SSOMobility Agent
The user’s device must have at least FortiClient Endpoint Security v5.0 installed. Only two pieces of information
are required to set up the SSO Mobility Agent feature: the FortiAuthenticator unit IP address and the preshared
secret.

The user needs to know the FortiAuthenticator IP address and preshared secret to set up the SSO Mobility Agent.
Or, you could preconfigure FortiClient.

To configure FortiClient SSO Mobility Agent:

1. In FortiClient Endpoint Security, go to File > Settings.
You must run the FortiClient application as an administrator to access these settings.

2. Select Enable single sign-on mobility agent. Enter the FortiAuthenticator unit IP address, including the
listening port number specified on the FortiAuthenticator unit.
Example: 192.168.0.99:8001. You can omit the port number if it is 8005.

3. Enter the preshared key.
4. Select OK.

Viewing SSO authentication events on the FortiGate unit
User authentication events are logged in the FortiGate event log.

Go to Log & Report > System Events.
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The FortiGate unit can authenticate users transparently and allow them network access based on their privileges
in Windows AD. This means that users who have logged on to the network are not asked again for their
credentials to access network resources through the FortiGate unit, hence the term “Single Sign-On”.

The following topics are included:

l Introduction to Single Sign-On with Windows AD
l Configuring Single Sign On to Windows AD
l FortiOS FSSO log messages
l Testing FSSO
l Troubleshooting FSSO

Introduction to Single Sign-On with Windows AD
Introduced in FortiOS 5.0, Single Sign-On (SSO) support provided by FortiGate polling of domain controllers is
simpler than the earlier method that relies on agent software installed on Windows AD network servers. No
Fortinet software needs to be installed on the Windows network. The FortiGate unit needs access only to the
Windows AD global catalog and event log.

When a Windows AD user logs on at a workstation in a monitored domain, the FortiGate unit

l detects the logon event in the domain controller’s event log and records the workstation name, domain, and user,
l resolves the workstation name to an IP address,
l uses the domain controller’s LDAP server to determine which groups the user belongs to,
l creates one or more log entries on the FortiGate unit for this logon event as appropriate.

When the user tries to access network resources, the FortiGate unit selects the appropriate security policy for the
destination. The selection consist of matching the FSSO group or groups the user belongs to with the security
policy or policies that match that group. If the user belongs to one of the permitted user groups associated with
that policy, the connection is allowed. Otherwise the connection is denied.

Configuring Single Sign On to Windows AD
On the FortiGate unit, security policies control access to network resources based on user groups. With Fortinet
Single Sign On, this is also true but each FortiGate user group is associated with one or more Windows AD user
groups. This is howWindows AD user groups get authenticated in the FortiGate security policy.

Fortinet Single Sign On sends information about Windows user logons to FortiGate units. If there are many users
on your Windows AD domains, the large amount of information might affect the performance of the FortiGate
unit.

To configure your FortiGate unit to operate with either a Windows AD or a Novell eDirectory FSSO install, you

l Configure LDAP access to the Windows AD global catalog. See Configuring LDAP server access on page 501.
l Configure the LDAP Server as a Single Sign-On server. See Configuring the LDAP Server as a Single Sign-On

server on page 502.

500 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Single Sign-On to Windows AD

l Add Active Directory user groups to FortiGate FSSO user groups. See Creating Fortinet Single Sign-On (FSSO)
user groups on page 503.

l Create security policies for FSSO-authenticated groups. See Creating security policies on page 503.
l Optionally, specify a guest protection profile to allow guest access. See Enabling guest access through FSSO

security policies on page 505

Configuring LDAP server access

The FortiGate unit needs access to the domain controller’s LDAP server to retrieve user group information.

The LDAP configuration on the FortiGate unit not only provides access to the LDAP server, it sets up the retrieval
of Windows AD user groups for you to select in FSSO. The LDAP Server configuration, found underUser
& Device > LDAP Servers, includes a function to preview the LDAP server’s response to your distinguished
name query. If you already know the appropriate Distinguished Name (DN) and User DN settings, you may be
able to skip some of the following steps.

To add an LDAP server - web-based manager:

1. Go to User & Device > LDAP Servers and select Create New.
2. Enter the Server IP/Name and Server Port (default 389).
3. In the Common Name Identifier field, enter sAMAccountName.The default common name identifier is cn.

This is correct for most LDAP servers. However some servers use other identifiers such as uid.
4. In the Distinguished Name field, enter your organization distinguished name. In this example, Distinguished

Name is dc=techdoc,dc=local
5. Select Fetch DN, this will fetch the Windows AD directory.

6. Set Bind Type to Regular.
7. In the User DN field, enter the administrative account name that you created for FSSO.

For example, if the account is administrator, enter “administrator@techdoc.local”.
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8. Enter the administrative account password in the Password field.
9. Optionally select Secure Connection.

l In the Protocol field, select LDAPS or STARTTLS.
l In the Certificate field, select the appropriate certificate for authentication.

Note that you need to configure the Windows AD for secure connection accordingly.

10. Select OK.
11. Test your configuration by selecting the Test button. A successful message confirming the right settings appears.

To configure LDAP for FSSO - CLI example:

config user ldap
edit LDAP

set server 10.10.20.3
set cnid sAMAccountName
set dn dc=techdoc,dc=local
set type regular
set username administrator@techdoc.local
set password <your_password>

next
end

Configuring the LDAP Server as a Single Sign-On server

The LDAP server must be added to the FortiGate Single Sign-On configuration.

To add the LDAP server as a Single Sign-On server:

1. Go to User & Device > Single Sign-On and select Create New.
2. Enter

Type Poll Active Directory Server

Server IP/Name Server Name or IP address of the Domain Controller

User ADomain user name

Password The user’s password
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LDAP Server Select the LDAP server you added earlier.

Enable Polling Select

3. Select OK.

Creating Fortinet Single Sign-On (FSSO) user groups

You cannot use Windows or Novell groups directly in FortiGate security policies. You must create FortiGate user
groups of the FSSO type and add Windows or Novell groups to them.

To create a user group for FSSO authentication - web-based manager:

1. Go to User & Device > User Groups and select Create New.
The New User Group dialog box opens.

2. In the Name box, enter a name for the group, FSSO_Internet_users for example.
3. In Type, select Fortinet Single Sign-On (FSSO).
4. InMembers, select the required FSSO groups.
5. Select OK.

To create the FSSO_Internet-users user group - CLI

config user group
edit FSSO_Internet_users

set group-type fsso-service
set member CN=Engineering,cn=users,dc=office,dc=example,dc=com

CN=Sales,cn=users,dc=office,dc=example,dc=com
end

Default FSSO group

SSO_Guest_users is a default user group enabled when FSSO is configured. It allows guest users on the
network who do not have an FSSO account to authenticate and have access to network resources. See Enabling
guest access through FSSO security policies on page 505.

Creating security policies

Policies that require FSSO authentication are very similar to other security policies. Using identity-based policies,
you can configure access that depends on the FSSO user group. This allows each FSSO user group to have its
own level of access to its own group of services

In this situation, Example.com is a company that has its employees and authentication servers on an internal
network. The FortiGate unit intercepts all traffic leaving the internal network and requires FSSO authentication to
access network resources on the Internet. The following procedure configures the security policy for FSSO
authentication. FSSO is installed and configured including the RADIUS server, FSSO Collector agent, and user
groups on the FortiGate

For the following procedure, the internal interface is port1 and the external interface connected to the Internet
is port2. There is an address group for the internal network called company_network. The FSSO user group
is called fsso_group, and the FSSO RADIUS server is fsso_rad_server.
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To configure an FSSO authentication security policy - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information.

Incoming Interface port1

Source Address company_network

Source User(s) fsso_group

Outgoing Interface port2

Destination Address all

Schedule always

Service HTTP, HTTPS, FTP, and Telnet

Action ACCEPT

NAT ON

UTM Security Profiles ON for AntiVirus, IPS, Web Filter, and Email Filter, all using default
profiles.

Log Allowed Traffic ON. Select Security Events.

3. Select OK.
4. Ensure the FSSO authentication policy is higher in the policy list than more general policies for the same

interfaces.

To create a security policy for FSSO authentication - CLI:

config firewall policy
edit 0

set srcintf port1
set dstintf port2
set srcaddr company_network
set dstaddr all
set action accept
set groups fsso_group
set schedule always
set service HTTP HTTPS FTP TELNET
set nat enable

end

Here is an example of how this FSSO authentication policy is used. Example.com employee on the internal
company network logs on to the internal network using their RADIUS username and password. When that user
attempts to access the Internet, which requires FSSO authentication, the FortiGate authentication security policy
intercepts the session, checks with the FSSO Collector agent to verify the user’s identity and credentials, and
then if everything is verified the user is allowed access to the Internet.
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Enabling guest access through FSSO security policies

You can enable guest users to access FSSO security policies. Guests are users who are unknown to Windows AD
and servers that do not logon to a Windows AD domain.

To enable guest access in your FSSO security policy, add an identity-based policy assigned to the built-in user
group SSO_Guest_Users. Specify the services, schedule and UTM profiles that apply to guest users—
typically guests have access to a reduced set of services. See Creating security policies on page 503.

FortiOS FSSO log messages
There are two types of FortiOS log messages— firewall and event. FSSO related log messages are generated
from authentication events. These include user logon and log off events, and NTLM authentication events. These
log messages are central to network accounting policies, and can also be useful in troubleshooting issues. For
more information on firewall logging, see Enabling security logging on page 449. For more information on
logging, see the FortiOS Handbook Logging and Reporting guide.

Enabling authentication event logging

For the FortiGate unit to log events, that specific type of event must be enabled under logging.

When VDOMs are enabled certain options may not be available, such as CPU and memory usage events. You
can enable event logs only when you are logged on to a VDOM; you cannot enable event logs globally.

To ensure you log all the events needed, set the minimum log level to Notification or Information. Firewall
logging requires Notification as a minimum. The closer to Debug level, the more information will be logged.

To enable event logging:

1. Go to Log & Report > Log Settings.
2. Under Log Settings, set Event Logging to Customize and select

System activity event All system-related events, such as ping server failure and gateway status.

User activity event All administration events, such as user logins, resets, and configuration
updates.

3. Select Apply.
      List of FSSO related log messages

Message ID Severity Description

43008 Notification Authentication was successful

43009 Notification Authentication session failed

43010 Warning Authentication locked out

43011 Notification Authentication timed out

43012 Notification FSSO authentication was successful
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Message ID Severity Description

43013 Notification FSSO authentication failed

43014 Notification FSSO user logged on

43015 Notification FSSO user logged off

43016 Notification NTLM authentication was successful

43017 Notification NTLM authentication failed

For more information on logging, see the FortiOS Handbook Logging and Reporting guide.

Extra filter options for security events

Logon events are detected by the FSSO CA by monitoring the Security Event logs. Additional logon event filters,
such as ServiceName and ServiceID, have been implemented so as to avoid instances of conflicting security
events, where existing user information could be overwritten.

Testing FSSO
Once FSSO is configured, you can easily test to ensure your configuration is working as expected. For additional
FSSO testing, see Troubleshooting FSSO on page 506.

1. Logon to one of the stations on the FSSO domain, and access an Internet resource.
2. Connect to the CLI of the FortiGate unit, and if possible log the output.
3. Enter the following command:diagnose debug authd fsso list

4. Check the output. If FSSO is functioning properly you will see something similar to the following:
----FSSO logons----
IP: 192.168.1.230 User: ADMINISTRATOR Groups: VLAD-AD/DOMAIN USERS
IP: 192.168.1.240 User: ADMINISTRATOR Groups: VLAD-AD/DOMAIN USERS
Total number of users logged on: 2
----end of FSSO logons----

The exact information will vary based on your installation.

5. Check the FortiGate event log, for FSSO-auth action or other FSSO related events with FSSO information in the
message field.

6. To check server connectivity, run the following commands from the CLI:
FGT# diagnose debug enable
FGT# diagnose debug authd fsso server-status
FGT# Server Name Connection Status
     ----------- -----------------
     SBS-2003 connected

Troubleshooting FSSO
When installing, configuring, and working with FSSO some problems are quite common. A selection of these
problems follows including explanations and solutions.

Some commonWindows AD problems include:
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l General troubleshooting tips for FSSO
l Users on a particular computer (IP address) can not access the network
l Guest users do not have access to network

General troubleshooting tips for FSSO

The following tips are useful in many FSSO troubleshooting situations.

l Ensure all firewalls are allowing the FSSO required ports through.
FSSO has a number of required ports that must be allowed through all firewalls or connections will fail. These include:
ports 139, 389 (LDAP), 445, 636 (LDAP).

l Ensure there is at least 64kbps bandwidth between the FortiGate unit and domain controllers. If there is insufficient
bandwidth, some FSSO information might not reach the FortiGate unit. The best solution is to configure traffic
shaping between the FortiGate unit and the domain controllers to ensure that the minimum bandwidth is always
available.

Users on a particular computer (IP address) can not access the network

Windows AD Domain Controller agent gets the username and workstation where the logon attempt is coming
from. If there are two computers with the same IP address and the same user trying to logon, it is possible for the
authentication system to become confused and believe that the user on computer_1 is actually trying to access
computer_2.

Windows AD does not track when a user logs out. It is possible that a user logs out on one computer, and
immediate logs onto a second computer while the system still believes the user is logged on the original
computer. While this is allowed, information that is intended for the session on one computer may mistakenly end
up going to the other computer instead. The result would look similar to a hijacked session.

Solutions

l Ensure each computer has separate IP addresses.
l Encourage users to logout on one machine before logging onto another machine.
l If multiple users have the same username, change the usernames to be unique.
l Shorten timeout timer to flush inactive sessions after a shorter time.

Guest users do not have access to network

A group of guest users was created, but they don’t have access.

Solution

The group of the guest users was not included in a policy, so they do not fall under the guest account. To give
them access, associate their group with a security policy.

Additionally, there is a default group called SSO_Guest_Users. Ensure that group is part of an identity-based
security policy to allow traffic.
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FortiOS can provide single sign-on capabilities to Windows AD, Citrix, Novell eDirectory, or, as of FortiOS 5.4,
Microsoft Exchange users with the help of agent software installed on these networks. The agent software sends
information about user logons to the FortiGate unit. With user information such as IP address and user group
memberships from the network, FortiGate security policies can allow authenticated network access to users who
belong to the appropriate user groups without requesting their credentials again.

For Windows AD networks, FortiGate units can provide SSO capability without agent software by directly polling
the Windows AD domain controllers. For information about this type of SSO, seeSingle Sign-On to Windows AD
on page 500.

The following topics are included:

l Introduction to agent-based FSSO
l FSSO NTLM authentication support
l Agent installation
l Configuring the FSSO Collector agent for Windows AD
l Configuring the FSSO TS agent for Citrix
l Configuring FSSO with Novell networks
l Configuring FSSO Advanced Settings
l Configuring FSSO on FortiGate units
l FortiOS FSSO log messages
l Testing FSSO
l Troubleshooting FSSO

Introduction to agent-based FSSO
Fortinet Single Sign-On (FSSO), through agents installed on the network, monitors user logons and passes that
information to the FortiGate unit. When a user logs on at a workstation in a monitored domain, FSSO

l detects the logon event and records the workstation name, domain, and user,
l resolves the workstation name to an IP address,
l determines which user groups the user belongs to,
l sends the user logon information, including IP address and groups list, to the FortiGate unit
l creates one or more log entries on the FortiGate unit for this logon event as appropriate.

When the user tries to access network resources, the FortiGate unit selects the appropriate security policy for the
destination. If the user belongs to one of the permitted user groups associated with that policy, the connection is
allowed. Otherwise the connection is denied.

FSSO can also provide NTLM authentication service for requests coming from
FortiGate. SSO is very convenient for users, but may not be supported across all
platforms. NTLM is not as convenient, but it enjoys wider support. See FSSO NTLM
authentication support on page 514.
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Introduction to FSSO agents

There are several different FSSO agents that can be used in an FSSO implementation:

l Domain Controller (DC) agent
l eDirectory agent
l Citrix/Terminal Server (TS) agent
l Collector (CA) agent

Consult the latest FortiOS and FSSO Release Notes for operating system compatibility information.

Domain Controller (DC) agent

The Domain Controller (DC) agent must be installed on every domain controller if you will use DC Agent mode,
but is not required if you use Polling mode. See FSSO for Windows AD on page 510.

eDirectory agent

The eDirectory agent is installed on a Novell network to monitor user logons and send the required information to
the FortiGate unit. It functions much like the Collector agent on a Windows AD domain controller.The agent can
obtain information from the Novell eDirectory using either the Novell API or LDAP.

Citrix/Terminal Server (TS) agent

The Citrix/Terminal Server (TS) agent is installed on a Citrix terminal server to monitor user logons in real time. It
functions much like the DC Agent on a Windows AD domain controller.

Collector (CA) agent

This agent is installed as a service on a server in the Windows AD network to monitor user logons and send the
required information to the FortiGate unit. The Collector agent can collect information from

l Domain Controller agent (Windows AD)
l TS agent (Citrix Terminal Server)

In a Windows AD network, the Collector agent can optionally obtain logon information by polling the AD domain
controllers. In this case, DC agents are not needed.

The Collector can obtain user group information from the DC agent or optionally, a FortiGate unit can obtain
group information directly from AD using Lightweight Directory Access Protocol (LDAP).

On a Windows AD network, the FSSO software can also serve NT LANManager (NTLM) requests coming from
client browsers (forwarded by the FortiGate unit) with only one or more Collector agents installed. See FSSO
NTLM authentication support on page 514.

The CA is responsible for DNS lookups, group verification, workstation checks, and as mentioned FortiGate
updates of logon records. The FSSO Collector Agent sends Domain Local Security Group and Global Security
Group information to FortiGate units. The CA communicates with the FortiGate over TCP port 8000 and it listens
on UDP port 8002 for updates from the DC agents.

The FortiGate unit can have up to five CAs configured for redundancy. If the first on the list is unreachable, the
next is attempted, and so on down the list until one is contacted. See Configuring FSSO on FortiGate units on
page 541.
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All DC agents must point to the correct Collector agent port number and IP address on domains with multiple
DCs.

A FortiAuthenticator unit can act much like a Collector agent, collecting Windows AD
user logon information and sending it to the FortiGate unit. It is particularly useful in
large installations with several FortiGate units. For more information, see the
FortiAuthenticator Administration Guide.

FSSO for Microsoft Exchange Server

As of FortiOS 5.4, FSSO supports monitoring Microsoft Exchange Server. This is useful for situations when the
user accesses the domain account to view their email, even when the client device might not be in the domain.

Support for the Exchange server is configured on the Back-end FSSO collector agent. For more information on
the collector agent, see Collector agent installation:

1. On the FSSO collector agent, go to Advanced Settings > Exchange Server.
2. Select Add and enter the following information and select OK:

Domain Name Enter your domain name.

Server IP/Hostname Enter the IP address or the hostname of your exchange server.

Polling forwarded
event log

This option for scenarios when you do not want that CA polls the Exchange
Server logs directly. In this case you need to configure event log forwarding on
the Exchange server. Exchange event logs can be forwarded to any member
server. If you enable this, instead of the IP of the Exchange server configured in
the previous step, you must then configure the IP of this member server. CA will
then contact the member server.

Ignore Name Because CAwill also checkWindows log files for logon events and when a user
authenticates to Exchange Server there is also a logon event in Windows event
log, which CAwill read and this will overwrite the Exchange Server logon event
(ESEventLog) on CA. So it is recommended to set the ignore list to the domain
the user belongs to.

To do so, enter the domain name in the Ignore Name field and select Add.

FSSO for Windows AD

FSSO for Windows AD requires at least one Collector agent. Domain Controller agents may also be required
depending on the Collector agent working mode. There are two working modes to monitor user logon activity:
DC Agent mode or Polling mode.

Collector agent DC Agent mode versus Polling mode

DC Agent mode Polling Mode

Installation Complex— Multiple installations: one
agent per DC plus Collector agent,
requires a reboot

Easy— Only Collector agent installation,
no reboot required
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DC Agent mode Polling Mode

Resources Shares resources with DC system Has own resources

Network load Each DC agent requires minimum 64kpbs
bandwidth, adding to network load

Increase polling period during busy period
to reduce network load

Level of
Confidence Captures all logons Potential to miss a login if polling period

is too great

DC Agent mode

DC Agent mode is the standard mode for FSSO. In DC Agent mode, a Fortinet authentication agent is installed
on each domain controller. These DC agents monitor user logon events and pass the information to the Collector
agent, which stores the information and sends it to the FortiGate unit.

The DC agent installed on the domain controllers is not a service like the Collector agent — it is a DLL file called
dcagent.dll and is installed in the Windows\system32 directory. It must be installed on all domain
controllers of the domains that are being monitored.

FSSO in DC agent mode

DC Agent mode provides reliable user logon information, however you must install a DC agent on every domain
controller. A reboot is needed after the agent is installed. Each installation requires some maintenance as well.
For these reasons it may not be possible to use the DC Agent mode.

Each domain controller connection needs a minimum guaranteed 64kpbs bandwidth to ensure proper FSSO
functionality. You can optionally configure traffic shapers on the FortiGate unit to ensure this minimum bandwidth
is guaranteed for the domain controller connections.

Polling mode

In Polling mode there are three options— NetAPI polling, Event log polling, and Event log using WMI. All share
the advantages of being transparent and agentless.

NetAPI polling is used to retrieve server logon sessions. This includes the logon event information for the
Controller agent. NetAPI runs faster than Event log polling but it may miss some user logon events under heavy
system load. It requires a query round trip time of less than 10 seconds.
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Event log polling may run a bit slower, but will not miss events, even when the installation site has many users
that require authentication. It does not have the 10 second limit on NetAPI polling. Event log polling requires fast
network links. Event log polling is required if there are Mac OS users logging into Windows AD.

Event log using WMI polling: WMI is a Windows API to get system information from a Windows server, CA is a
WMI client and sendsWMI queries for user logon events to DC, which in this case is a WMI server. Main
advantage in this mode is that CA does not need to search security event logs on DC for user logon events,
instead, DC returns all requested logon events via WMI. This also reduces network load between CA and DC.

In Polling mode, the Collector agent polls port 445 of each domain controller for user logon information every few
seconds and forwards it to the FortiGate unit. There are no DC Agents installed, so the Collector agent polls the
domain controllers directly.

FSSO in Polling mode

Amajor benefit of Polling mode is that no FSSO DC Agents are required. If it is not possible to install FSSO DC
Agents on your domain controllers, this is the alternate configuration available to you. Polling mode results in a
less complex install, and reduces ongoing maintenance. The minimum permissions required in Polling mode are
to read the event log or call NetAPI.

Collector agent AD Access mode - Standard versus Advanced

The Collector agent has two ways to access Active Directory user information. The main difference between
Standard and Advanced mode is the naming convention used when referring to username information.

Standard mode uses regular Windows convention: Domain\Username. Advanced mode uses LDAP convention:
CN=User, OU=Name, DC=Domain.

If there is no special requirement to use LDAP— best practices suggest you set up FSSO in Standard mode. This
mode is easier to set up, and is usually easier to maintain and troubleshoot.

Standard and advanced modes have the same level of functionality with the following exceptions:

l Users have to create Group filters on the Collector agent. This differs from Advanced mode where Group filters are
configured from the FortiGate unit. Fortinet strongly encourages users to create filters from CA.

l Advanced mode supports nested or inherited groups. This means that users may be a member of multiple
monitored groups. Standard mode does not support nested groups so a user must be a direct member of the group
being monitored.
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FSSO for Citrix

Citrix users can enjoy a similar Single Sign-On experience asWindows AD users. The FSSO TS agent installed
on each Citrix server provides user logon information to the FSSO Collector agent on the network. The FortiGate
unit uses this information to authenticate the user in security policies.

Citrix SSO topology

Citrix users do not have unique IP addresses. When a Citrix user logs on, the TS agent assigns that user a range
of ports. By default each user has a range of 200 ports.

FSSO for Novell eDirectory

FSSO in a Novell eDirectory environment works similar to the FSSO Polling mode in the Windows AD
environment. The eDirectory agent polls the eDirectory servers for user logon information and forwards the
information to the FortiGate unit. There is no need for the Collector agent.

When a user logs on at a workstation, FSSO:

l detects the logon event by polling the eDirectory server and records the IP address and user ID,
l looks up in the eDirectory which groups this user belongs to,
l sends the IP address and user groups information to the FortiGate unit.

When the user tries to access network resources, the FortiGate unit selects the appropriate security policy for the
destination. If the user belongs to one of the permitted user groups, the connection is allowed.

FSSO is supported on the Novell E-Directory 8.8 operating system.

For a Novell network, there is only one FSSO component to install — the eDirectory agent. In some cases, you
also need to install the Novell Client.
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FSSO security issues

When the different components of FSSO are communicating there are some inherent security features.

FSSO installation requires an account with network admin privileges. The security inherent in these types of
accounts helps ensure access to FSSO configurations is not tampered with.

User passwords are never sent between FSSO components. The information that is sent is information to identify
a user including the username, group or groups, and IP address.

NTLM uses base-64 encoded packets, and uses a unique randomly generated challenge nonce to avoid sending
user information and password between the client and the server.

FSSO NTLM authentication support
In a Windows AD network, FSSO can also provide NTLM authentication service to the FortiGate unit. When the
user makes a request that requires authentication, the FortiGate unit initiates NTLM negotiation with the client
browser. The FortiGate unit does not process the NTLM packets itself. Instead, it forwards all the NTLM packets
to the FSSO service to process.

NTLM has the benefit of not requiring an FSSO agent, but it is not transparent to users, and the user’s web
browser must support NTLM.

The NTLM protocol protects the user’s password by not sending it over the network. Instead, the server sends the
client a random number that the client must encrypt with the hash value of the user's password. The server
compares the result of the client's encryption with the result of its own encryption. The two will match only if both
parties used the same password.
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NTLM authentication

If the NTLM authentication with the Windows AD network is successful, and the user belongs to one of the groups
permitted in the applicable security policy, the FortiGate unit allows the connection but will require authentication
again in the future when the current authentication expires.

Fortinet has tested NTLM authentication with Internet Explorer and Firefox browsers.

NTLM in a multiple domain environment

In a multiple domain environment for NTLM, the important factor is that there is a trust relation between the
domains. In a forest, this relation is automatically created. So you can install FSSO agent on one of the domain
controllers without worry.

But in case of multiple domains that are not in a forest, you need to create a trust relation between the domains.
If you do not want to have a trust relation between your multiple domains, you need to use FSAE 4.0 MR1 and
the DC agent needs to be installed once on each domain. Then you can use security policies to configure server
access.

In the figure below, three domains are shown connected to the FSSO Collector agent server. The Client logs on
to their local Domain Controller, which then sends the user logon event information to the Collector Agent. When
the Client attempts to access the Internet, the FortiGate unit contacts the Collector Agent for the logon
information, sees the Client is authenticated, and allows access to the Internet. There are multiple domains each
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with a domain controller agent (DCagent) that sends logon information to the Collector agent. If the multiple
domains have a trust relationship, only one DCagent is required instead of one per domain.

FSSO NTLM with multiple domains not in a forest

Understanding the NTLM authentication process

1. The user attempts to connect to an external (internet) HTTP resource. The client application (browser) on the
user’s computer issues an unauthenticated request through the FortiGate unit.

2. The FortiGate is aware that this client has not authenticated previously, so responds with a 401
Unauthenticated status code, and tells the client which authentication method to reply with in the header:
Proxy-Authenticated: NTLM. Then the initial session is dismantled.

3. The client application connects again to the FortiGate, and issues a GET-request, with a
Proxy-Authorization: NTLM <negotiate string> header. <negotiate-string> is a base64-
encoded NTLM Type 1 negotiation packet.

4. The FortiGate unit replies with a 401 “proxy auth required” status code, and a
Proxy-Authenticate: NTLM <challenge string> (a base 64-encoded NTLM Type 2 challenge
packet). In this packet is the challenge nonce, a random number chosen for this negotiation that is used once and
prevents replay attacks.

The TCP connection must be kept alive, as all subsequent authentication-related
information is tied to the TCP connection. If it is dropped, the authentication process
must start again from the beginning.

5. The client sends a new GET-request with a header: Proxy-Authenticate: NTLM <authenticate
string>, where <authenticate string> is a NTLM Type 3 Authentication packet that contains:
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l username and domain
l the challenge nonce encoded with the client password (it may contain the challenge nonce twice using different

algorithms).

6. If the negotiation is successful and the user belongs to one of the groups permitted in the security policy, the
connection is allowed, Otherwise, the FortiGate unit denies the authentication by issuing a 401 return code and
prompts for a username and password. Unless the TCP connection is broken, no further credentials are sent from
the client to the proxy.

If the authentication policy reaches the authentication timeout period, a new NTLM
handshake occurs.

Agent installation
After reading the appropriate sections of Introduction to agent-based FSSO on page 508 to determine which
FSSO agents you need, you can proceed to perform the necessary installations.

Ensure you have administrative rights on the servers where you are installing FSSO agents. It is best practice to
install FSSO agents using the built-in local administrator account. Optionally, you can install FSSO without an
admin account. See Installing FSSO without using an administrator account on page 519.

In Windows 2008 by default, you do not have administrative user rights if you are
logged on as a user other than as the built-in administrator, even if you were added to
the local Administrators group on the computer.

The FSSO installer first installs the Collector agent. You can then continue with installation of the DC agent, or
you can install it later by going to Start > Programs > Fortinet > Fortinet Single Sign On Agent >
Install DC Agent. The installer will install a DC agent on the domain controllers of all of the trusted domains in
your network.

Each domain controller connection needs a minimum guaranteed 64kpbs bandwidth
to ensure proper FSSO functionality.Traffic shapers configured on the FortiGate can
help guarantee these minimum bandwidths.

Collector agent installation

To install FSSO, you must obtain the FSSO_Setup file from the Fortinet Support web site. This is available as
either an executable (.exe) or a Microsoft Installer (.msi) file. Then you follow these two installation procedures on
the server that will run the Collector agent. This can be any server or domain controller that is part of your
network. These procedures also installs the DC Agent on all of the domain controllers in your network.

IPv6 source addresses can be configured for connecting to an FSSO agent.
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To install the Collector agent:

1. Create an account with administrator privileges and a password that does not expire. See Microsoft Advanced
Server documentation for help with this task.
To use a non-admin read only account, see Installing FSSO without using an administrator account on page 519.

2. Log on to the account that you created in Step 1.
3. Double-click the FSSOSetup.exe file.

The Fortinet SSO Collector Agent Setup Wizard starts.
4. Select Next.
5. Read and accept the license agreement. Select Next.
6. Optionally, you can change the installation location. Select Next.
7. Optionally, change the User Name.
8. By default, the agent is installed using the currently running account. If you want FSSO to use another existing

admin account, change the User Name using the format DomainName \ UserName. For example if the account
is jsmith and the domain is example_corp you would enter example_corp\jsmith.

9. In the Password field, enter the password for the account listed in the User Name field.
10. Select Next.
11. Enable as needed:

l Monitor user logon events and send the information to the FortiGate unit
l Serve NTLM authentication requests coming from FortiGate

By default, both methods are enabled. You can change these options after installation.

12. Select the access method to use for Windows Directory:
13. Select Standard to use Windows domain and username credentials.
14. Select Advanced if you will set up LDAP access to Windows Directory.

See Collector agent AD Access mode - Standard versus Advanced on page 512.
15. Select Next and then select Install.

If you want to use DC Agent mode, ensure that Launch DC Agent Install Wizard is selected. This will start DC
agent installation immediately after you select Finish.

16. Select Finish.

If you see an error such as Service Fortinet Single Sign On agent (service_FSAE)
failed to start, there are two possible reasons for this. Verify the user account you
selected has sufficient privileges to run the FSSO service. Also verify the computer
system you are attempting to install on is a supported operating system and version.

DC agent installation

The FSSO_Setup file contains both the Collector agent and DC Agent installers, but the DC Agent installer is also
available separately as either a .exe or .msi file named DCAgent_Setup.

To install the DC Agent

1. If you have just installed the Collector agent, the FSSO - Install DC Agent wizard starts automatically. Otherwise,
go to Start > Programs > Fortinet > Fortinet Single Sign On Agent > Install DC Agent.

2. Select Next.
3. Read and accept the license agreement. Select Next.
4. Optionally, you can change the installation location. Select Next.
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5. Enter the Collector agent IP address.
6. If the Collector agent computer has multiple network interfaces, ensure that the one that is listed is on your

network. The listed Collector agent listening port is the default. Only change this if the port is already used by
another service.

7. Select Next.
8. Select the domains to monitor and select Next.
9. If any of your required domains are not listed, cancel the wizard and set up the proper trusted relationship with the

domain controller. Then run the wizard again by going to Start > Programs > Fortinet >
Fortinet Single Sign On Agent > Install DC Agent.

10. Optionally, select users that you do not want monitored. These users will not be able to authenticate to FortiGate
units using FSSO. You can also do this later. See Configuring the FSSO Collector agent for Windows AD on page
522.

11. Select Next.
12. Optionally, clear the check boxes of domain controllers on which you do not want to install the DC Agent.
13. Select theWorking Mode as DC Agent Mode. While you can select Polling Mode here, in that situation you

would not be installing a DC Agent. For more information, see DC Agent mode on page 511 and Polling mode on
page 511.

14. Select Next.
15. Select Yeswhen the wizard requests that you reboot the computer.

If you reinstall the FSSO software on this computer, your FSSO configuration is
replaced with default settings.

If you want to create a redundant configuration, repeat the Collector agent installation procedure on at least one
other Windows AD server.

When you start to install a second Collector agent, cancel the Install Wizard dialog
appears the second time. From the configuration GUI, the monitored domain
controller list will show your domain controllers un-selected. Select the ones you wish
to monitor with this Collector agent, and select Apply.

Before you can use FSSO, you need to configure it on both Windows AD and on the FortiGate units. Configuring
FSSO on FortiGate units on page 541 will help you accomplish these two tasks.

Installing FSSO without using an administrator account

Normally when installing services in Windows, it is best to use the Domain Admin account, as stated earlier. This
ensures installation goes smoothly and uninterrupted, and when using the FSSO agent there will be no
permissions issues. However, it is possible to install FSSO with a non-admin account in Windows 2003 or 2008
AD.

The following instructions for Windows 2003 are specific to the event log polling mode
only. Do not use this procedure with other FSSO configurations.
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Windows 2003

There are two methods in Windows 2003 AD for installing FSSO without an admin account — add the non-admin
user to the security log list, and use a non-admin account with read-only permissions. A problem with the first
method is that full rights (read, write, and clear) are provided to the event log. This can be a problem when audits
require limited or no write access to logs. In those situations, the non-admin account with read-only permissions
is the solution.

To add the non-admin user account to the Windows 2003 security log list :

1. Go to Default Domain Controller Security Settings > Security Settings > User Rights Assignment >
Manage auditing and security log.

2. Add the user account to this list.
3. Repeat these steps on every domain controller in Windows 2003 AD.

A reboot is required.

To use a non-admin account with read-only permissions to install FSSO on Windows 2003:

The following procedure provides the user account specified with read only access to the Windows 2003 AD
Domain Controller Security Event Log which allows FSSO to function.

1. Find out the SID of the account you intend to use.
Tools for this can be downloaded for free from http://technet.microsoft.com/en-us/sysinternals/bb897417.

2. Then create the permission string. For example:
l (A;;0x1;;;S-1-5-21-4136056096-764329382-1249792191-1107)

l A means Allow,
l 0x1 means Read, and
l S-1-5-21-4136056096-764329382-1249792191-1107 is the SID.

3. Then, append it to the registry key:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Eventlog\Security\CustomSD

4. Repeat these steps on every domain controller in Windows 2003 AD.
A reboot is required.

Windows 2008

In Windows 2008 AD, if you do not want to use the Domain Admin account then the user account that starts the
FSSO agent needs to be added to the Event Log Readers group.

When the user is added to the Event Log Readers group, that user is now allowed to have read only access to the
event log and this is the minimal rights required for FSSO to work.

Citrix TS agent installation

To install the Citrix TS agent, you must obtain the TSAgent_Setup file from the Fortinet Support web site.
Perform the following installation procedure on the Citrix server.

To install the FSSO TS agent:

1. On the Citrix server, create an account with administrator privileges and a password that does not expire. See
Citrix documentation for more information.

2. Log on to the account that you created in step 1.
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3. Double-click the TSAgent_Setup installation file.
The Fortinet SSO Terminal Server Agent Setup Wizard starts.

4. Select Next.
5. Read and accept the license agreement. Select Next.
6. Optionally, you can change the installation location. Select Next.
7. Verify that This Host IP Address is correct.
8. In the FSSO Collector Agent List, enter the IP address(es) of your Collector Agents.
9. Select Next and then select Install.

The TS agent is installed.
10. Select Finish.

Novell eDirectory agent installation

To install the eDirectory agent, you must obtain the FSSO_Setup_eDirectory file from the Fortinet Support web
site. Perform the following installation procedure on the computer that will run the eDirectory agent. This can be
any server or domain controller that is part of your network. You will need to provide some setup information.

To install the FSSO eDirectory agent:

1. Create an account with administrator privileges and a password that does not expire. See Novell documentation
for more information.

2. Log on to the account that you created in step 1.
3. Double-click the FSSO_Setup_edirectory file to start the installation wizard.
4. Select Next.
5. Read and accept the license agreement. Select Next.
6. Optionally, change the installation location. Select Next.
7. Enter:

eDirectory Server

Server Address Enter the IP address of the eDirectory server.

Use secure connection (SSL) Select to connect to the eDirectory server using SSL security.

Search Base DN Enter the base Distinguished Name for the user search.

eDirectory Authentication

Username Enter a username that has access to the eDirectory, using LDAP format.

User password Enter the password.

8. Select Next.
9. Select Install. When the installation completes, select Finish.

Updating FSSO agents on Windows AD

After FSSO is installed on your network, you may want to upgrade to a newer version. The following procedure
helps ensure you have a trouble free upgrade. How you update FSSO depends on if you are using polling mode or
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DCAgent mode.

For polling mode, since there are no DC agents you only need to upgrade the Collector. However in DCAgent
mode, each DC Agent must be updated as well.

To update FSSO in DC Agent mode:

1. Go to the system32 directory on all DC's and rename the dcagent.dll file to dcagent.dll.old.
This ensures the when the upgrade is pushed to the DC it does not overwrite the old file. If there are any problems
this makes it easy to revert to the old version.

2. Run the FSSO setup .exe file to update the collector. When this is completed, ignore any reboot message.
3. Go to Programs > Fortinet > Fortinet Single Sign On Agent > Install DC Agent and push the DC agent

out to all servers. All DC's will now need to be rebooted so that the new DLL file is loaded.
4. After the reboot, go to all DC’s and delete the dcagent.dll.old files.

Configuring the FSSO Collector agent for Windows AD
On the FortiGate unit, security policies control access to network resources based on user groups. With Fortinet
Single Sign On, this is also true but each FortiGate user group is associated with one or more Windows AD user
groups. This is howWindows AD user groups get authenticated in the FortiGate security policy.

Fortinet Single Sign On sends information about Windows user logons to FortiGate units. If there are many users
on your Windows AD domains, the large amount of information might affect the performance of the FortiGate
units.

To avoid this problem, you can configure the Fortinet Single Sign On Collector agent to send logon information
only for groups named in the FortiGate unit’s security policies. See Configuring FortiGate group filters on page
529.

On each server with a Collector agent, you will be

l Configuring Windows AD server user groups
l Configuring Collector agent settings, including the domain controllers to be monitored
l Selecting Domain Controllers and working mode for monitoring
l Configuring Directory Access settings
l Configuring the Ignore User List
l Configuring FortiGate group filters for each FortiGate unit
l Configuring FSSO ports
l Configuring alternate user IP address tracking
l Viewing FSSO component status

Configuring Windows AD server user groups

FortiGate units control network resource access at the group level. All members of a user group have the same
network access as defined in FortiGate security policies.

You can use existing Windows AD user groups for authentication to FortiGate units if you intend that all members
within each group have the same network access privileges.

Otherwise, you need to create new user groups for this purpose.
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If you change a user’s group membership, the change does not take effect until the
user logs off and then logs on again.

The FSSO Agent sends only Domain Local Security Group and Global Security Group
information to FortiGate units. You cannot use Distribution group types for FortiGate
access. No information is sent for empty groups.

Refer to Microsoft documentation for information about creating and managing Windows AD user groups.

Configuring Collector agent settings

You need to configure which domain controllers the Collector agent will use and which domains to monitor for
user logons. You can also alter default settings and settings you made during installation. These tasks are
accomplished by configuring the FSSO Collector Agent, and selecting either Apply to enable the changes.

At any time to refresh the FSSO Agent settings, select Apply.

To configure the Collector agent:

1. From the Start menu, select Programs > Fortinet > Fortinet Single Sign-On Agent >
Configure Fortinet Single Sign-On Agent.

2. Enter the following information.
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Monitoring user logon events
By default, this is enabled to automatically authenticate users as they
log on to the Windows domain. Disable the Monitor feature only if you
have a large network where this feature will slow responses too much.

Support NTLM authentication

By default, this is enabled to facilitate logon of users who are
connected to a domain that does not have the FSSO DC Agent
installed. Disable NTLM authentication only if your network does not
support NTLM authentication for security or other reasons.

Collector Agent Status Shows RUNNING when Collector agent is active.

Listening ports You can change FSSO Collector Agent related port numbers if
necessary.

FortiGate TCP port for FortiGate units. Default 8000.

DC Agent UDP port for DC Agents. Default 8002.

Logging

Log level Select the minimum severity level of logged messages.

Log file size limit
(MB) Enter the maximum size for the log file in MB. Default is 10.

View Log View all Fortinet Single Sign On agent logs.

Log logon events in
separate logs

Record user login-related information separately from other
logs. The information in this log includes:

l data received from DC agents
l user logon/logoff information
l workstation IP change information
l data sent to FortiGate units

View Logon Events If Log logon events in separate logs is enabled, you can view user
login-related information.

Authentication

Require authenticated
connection from
FortiGate

Select to require the FortiGate unit to authenticate before connecting
to the Collector agent.

Password
Enter the password that FortiGate units must use to authenticate. The
maximum password length is 15 characters. The default password is
“fortinetcanada”. It is highly recommended to modify this password.

Timers
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Workstation verify
interval (minutes)

Enter the interval in minutes at which the Fortinet Single Sign On
Collector agent connects to client computers to determine whether the
user is still logged on. The default is every 5 minutes. The interval may
be increased if your network has too much traffic.

Note: This verification process creates security log entries on the client
computer.

If ports 139 or 445 cannot be opened on your network, set the interval
to 0 to prevent checking. See Configuring FSSO ports on page 530.

Dead entry timeout
interval

Enter the interval in minutes after which Fortinet Single Sign On Agent
purges information for user logons that it cannot verify. The default is
480 minutes (8 hours).

Dead entries usually occur because the computer is unreachable (such
as in standby mode or disconnected) but the user has not logged off. A
common reason for this is when users forget to logoff before leaving
the office for the day.

You can also prevent dead entry checking by setting the interval to 0.

IP address change
verify interval

Fortinet Single Sign On Agent periodically checks the IP addresses of
logged-in users and updates the FortiGate unit when user IP
addresses change. IP address verification prevents users from being
locked out if they change IP addresses, as may happen with DHCP
assigned addresses.

Enter the verification interval in seconds. The default is 60 seconds.
You can enter 0 to prevent IP address checking if you use static IP
addresses.

This does not apply to users authenticated through NTLM.

Cache user group lookup
result

Enable caching.

Caching can reduce group lookups and increase performance.

Cache expire in
(minutes)

Fortinet Single Sign On Agent caches group information for logged-in
users.

Enter the duration in minutes after which the cache entry expires. If
you enter 0, the cache never expires.

A long cache expire interval may result in more stale user group
information. This can be an issue when a user’s group information is
changed.

Clear Group Cache
Clear group information of logged-in users.

This affects all logged-in users, and may force them to re-logon.

3. You can select Save&Close now or leave the agent configuration window open to complete additional
configuration in the following sections.
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To view the version and build number information for your FSSO Collector Agent
configuration, selecting the Fortinet icon in the upper left corner of the Collector agent
Configuration screen and select About Fortinet Single Sign On Agent
configuration.

Selecting Domain Controllers and working mode for monitoring

You can change which DC agents are monitored or change the working mode for logon event monitoring between
DC agent mode and polling mode.

When polling mode is selected, it will poll port 445 of the domain controller every few seconds to see who is
logged on.

1. From the Start menu select Programs > Fortinet Fortinet Single Sign-On Agent > Configure Fortinet
Single Sign On Agent.

2. In the Common Tasks section, select Show Monitored DCs.
3. Select Select DC to Monitor.

4. Choose theWorking Mode:
l DC Agent mode— a Domain Controller agent monitors user logon events and passes the information to the

Collector agent. This provides reliable user logon information, however you must install a DC agent on every
domain controller in the domain.

l Polling mode— the Collector agent polls each domain controller for user logon information. Under heavy
system load this might provide information less reliably. However installing a DC agent on each domain
controller is not required in this mode.

5. You also need to choose the method used to retrieve logon information:
l Poll logon sessions using Windows NetAPI
l CheckWindows Security Event Logs
l CheckWindows Security Event Logs using WMI

For more information about these options, see Polling mode on page 511.
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6. Select OK.
7. Select Close.
8. Select Save & Close.

Configuring Directory Access settings

The FSSO Collector Agent can accessWindows Active Directory in one of two modes:

l Standard — the FSSO Collector Agent receives group information from the Collector agent in the domain\user
format. This option is available on FortiOS 3.0 and later.

l Advanced— the FSSO Collector Agent obtains user group information using LDAP. The benefit of this method is
that it is possible to nest groups within groups. This is option is available on FortiOS 3.0 MR6 and later. The group
information is in standard LDAP format.

If you change AD access mode, you must reconfigure your group filters to ensure that
the group information is in the correct format.

To configure Directory Access settings:

1. From the Start menu select Programs > Fortinet > Fortinet Single Sign On Agent > Configure Fortinet
Single Sign On Agent.

2. In the Common Tasks section, select Set Directory Access Information.
The Set Directory Access Information dialog box opens.

3. From the AD access mode list, select either Standard orAdvanced.
4. If you selected Advanced AD access mode, select Advanced Setting and configure the following settings and

then select OK:

AD server address Enter the address of your network’s global catalog server.

AD server port The default AD server port is 3268. This must match your server port.

BaseDN Enter the Base distinguished name for the global catalog. This is the point
in the tree that will be considered the starting point by default-See following
example.

Username If the global catalog accepts your Fortinet Single Sign On Agent agent’s
credentials, you can leave these fields blank. Otherwise, enter credentials
for an account that can access the global catalog.Password

BaseDN example

An example DN for Training Fortinet Canada is ou=training, ou=canada, dc=fortinet, dc=com. If
you set the BaseDN to ou=canada, dc=fortinet, dc=com then when Fortinet Single Sign On Agent is
looking up user credentials, it will only search the Canada organizational unit, instead of all the possible countries
in the company. Its a short cut to entering less information and faster searches.

However, you may have problems if you narrow the BaseDN too much when you have international employees
from the company visiting different offices. If someone from Fortinet Japan is visiting the Canada office in the
example above, their account credentials will not be matched because they are in ou=japan,
dc=fortinet, dc=com instead of the BaseDN ou=canada, dc=fortinet, dc=com. The easy solution
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is to change the BaseDN to simply be dc=fortinet, dc=com. Then any search will check all the users in the
company.

Configuring the Ignore User List

The Ignore User List excludes users that do not authenticate to any FortiGate unit, such as system accounts. The
logons of these users are not reported to FortiGate units. This reduces the amount of required resources on the
FortiGate unit especially when logging logon events to memory.

To configure the Ignore User List:

1. From the Start menu select Programs > Fortinet > Fortinet Single Sign On Agent > Configure Fortinet
Single Sign On Agent.

2. In the Common Tasks section, select Set Ignore User List.
The current list of ignored users is displayed:

3. Do any of the following:
l To remove a user from the list, select the the username and then select Remove. The user’s login is no longer

ignored.
l To add users to be ignored,

l enter the username in the format domain\username and select Add or
l select Add Users, an Add Ignore Userswindow is displayed, checkmark the users you do not want

to monitor, then select Add or
l select Add by OU, an Add Ignore Users by OU window is displayed, select an OU from the

directory tree, then select Add. All users under the selected OU will be added to the ignore user list.

4. Select OK.
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Configuring FortiGate group filters

FortiGate group filters actively control which user logon information is sent to each FortiGate unit. You need to
configure the group filter list so that each FortiGate unit receives the correct user logon information for the user
groups that are named in its security policies. These group filters help limit the traffic sent to the FortiGate unit,
and help limit the logon events logged.

The maximum number of Windows AD user groups allowed on a FortiGate depends on the model. Low end
models support 256 Windows AD user groups, where mid and high end models support 1024 groups. This is per
VDOM if VDOMs are enabled on the FortiGate unit.

You do not need to configure a group filter on the Collector agent if the FortiGate unit retrieves group information
from Windows AD using LDAP. In that case, the Collector agent uses the list of groups you selected on the
FortiGate unit as its group filter.

The filter list is initially empty. You need to configure filters for your FortiGate units using the Add function. At a
minimum, create a default filter that applies to all FortiGate units without a defined filter.

If no filter is defined for a FortiGate unit and there is no default filter, the Collector
agent sends all Windows AD group and user logon events to the FortiGate unit. While
this normally is not a problem, limiting the amount of data sent to the FortiGate unit
improves performance by reducing the amount of memory the unit uses to store the
group list and resulting logs.

To configure a FortiGate group filter:

1. From the Start menu select Programs > Fortinet > Fortinet Single Sign On Agent > Configure Fortinet
Single Sign On Agent.

2. In the Common Tasks section, select Set Group Filters.
The FortiGate Filter List opens. It has the following columns:

FortiGate SN The serial number of the FortiGate unit to which this filter applies.

Description An optional description of the role of this FortiGate unit.

Monitored Groups The Windows AD user groups that are relevant to the security policies on
this FortiGate unit.

Add Create a new filter.

Edit Modify the filter selected in the list.

Remove Remove the filter selected in the list.

OK Save the filter list and exit.

Cancel Cancel changes and exit.

3. Select Add to create a new filter. If you want to modify an existing filter, select it in the list and then select Edit.
4. Enter the following information and then select OK.
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Default filter Select to create the default filter. The default filter applies to any FortiGate
unit that does not have a specific filter defined in the list.

FortiGate Serial Number Enter the serial number of the FortiGate unit to which this filter applies.
This field is not available if Default is selected.

Description Enter a description of this FortiGate unit’s role in your network. For
example, you could list the resources accessed through this unit. This field
is not available if Default is selected.

Monitor the following
groups

The Collector agent sends to the FortiGate unit the user logon information
for the Windows AD user groups in this list. Edit this list using the Add,
Advanced and Remove buttons.

Add In the preceding single-line field, enter the Windows AD domain name and
user group name, and then select Add. If you don’t know the exact name,
use the Advanced button instead.

The format of the entry depends on the AD access mode (see Configuring
Directory Access settings on page 527):

Standard: Domain\Group

Advanced: cn=group, ou=corp, dc=domain

Advanced Select Advanced, select the user groups from the list, and then select
Add.

Remove Remove the user groups selected in the monitor list.

Configuring FSSO ports

For FSSO to function properly a small number of TCP and UDP ports must be open through all firewalls on the
network. There ports listed in this section assume the default FSSO ports are used.

TCP ports for FSSO agent with client computers

Windows AD records when users log on but not when they log off. For best performance, Fortinet Single Sign On
Agent monitors when users log off. To do this, Fortinet Single Sign On Agent needs read-only access to each
client computer’s registry over TCP port 139 or 445. Open at least one of these ports— ensure it is not blocked by
firewalls.

If it is not feasible or acceptable to open TCP port 139 or 445, you can turn off Fortinet Single Sign On Agent
logoff detection. To do this, set the Collector agent workstation verify interval to 0. The FSSO Collector Agent
assumes that the logged on computer remains logged on for the duration of the Collector agent dead entry
timeout interval — by default this is eight hours.

Configuring ports on the Collector agent computer

On the computer where you install the Collector agent, you must make sure that the firewall does not block the
listening ports for the FortiGate unit and the DC Agent. By default, these are TCP port 8000 and UDP port 8002.
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For more information about setting these ports, see Configuring FSSO Advanced Settings on page 536.

Configuring alternate user IP address tracking

In environments where user IP addresses change frequently, you can configure Fortinet Single Sign On Agent to
use an alternate method to track user IP address changes. Using this method, Fortinet Single Sign On Agent
responds more quickly to user IP address changes because it directly queries workstation IP addresses to match
users and IP addresses.

This feature requires FSAE version 3.5.27 or later, Fortinet Single Sign On Agent any version, and FortiOS 3.0
MR7 or later.

To configure alternate user IP address tracking:

1. On the computer where the Collector agent is installed, go to Start > Run.
2. Enter regedit or regedt32 and select OK.

The Registry Editor opens.
3. Find the registry key HKEY_LOCAL_MACHINE\SOFTWARE\Fortinet\FSAE\collectoragent.
4. Set the supportFSAEauth value (dword) to 00000001.

If needed, create this new dword.
5. Close the Registry Editor.
6. From the Start menu select Programs > Fortinet > Fortinet Single Sign On Agent > Configure Fortinet

Single Sign On Agent.
7. Select Apply.

The Fortinet Single Sign On Agent service restarts with the updated registry settings.

Viewing FSSO component status

It is important to know the status of both your Collector agents and DC agents.

Viewing Collector agent status

Use the Show Service Status to view your Collector agent information in the Status window. The Status
window displays:

l the version of the software
l the status of the service
l the number of connected FortiGate units
l connected FortiGate information such as serial number, IP address, and connect time

To view Collector agent status:

1. From the Start menu select Programs > Fortinet > Fortinet Single Sign On Agent > Configure Fortinet
Single Sign On Agent.

2. In the Common Tasks section, select Show Service Status.
The Fortinet Single Sign On Collector agent Status window opens.

3. Optionally select Get NTLM statistics in the Status window to display NTLM information such as number of
messages received, processed, failed, in the queue.
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Viewing DC agent status

Use the Show Monitored DCs to view the status of DC agents.

To view domain controller agent status:

1. From the Start menu select Programs > Fortinet > Fortinet Single Sign On Agent > Configure Fortinet
Single Sign On Agent.

2. In the Common Tasks section, select Show Monitored DCs.
For each DC Agent, the following information is displayed:
l IP address
l number of logon events received
l the last logon event
l when last logon was received

To change which DC agents are monitored or change the working mode for logon event monitoring, select Select
DC to Monitor
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Configuring the FSSO TS agent for Citrix
The FSSO TS agent works with the same FSSO Collector agent that is used for integration with Windows Active
Directory. Install the Collector agent first. Follow the Collector agent installation procedure in Collector agent
installation on page 517.

FortiOS 5.6 supports FSSO DC/TS Agent v.5.x.

Configuration steps include:

l Install the Fortinet Citrix FSSO agent on the Citrix server.
l Install the Fortinet FSSO collector on a server on the network.
l Add the Citrix FSSO agent to the FortiGate Single-sign-On configuration.
l Add Citrix FSSO groups and users to an FSSO user group.
l Add an FSSO identity-based security policy that includes the Citrix FSSO user groups.

To change the TS agent configuration, select from the Start menu Programs > Fortinet > Fortinet Single
Sign-On Agent > TSAgent Config. In addition to the host and Collector agent IP addresses that you set
during installation, you can adjust port allocations for Citrix users. When a Citrix user logs on, the TS agent
assigns that user a range of ports. By default each user has a range of 200 ports.

Fortinet SSO Collector Agent IP and Port needs to point to the current configured
listening port on the collector which is port 8002 by default. Though it may be
configured to a custom port.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

533



Agent-based FSSO

Configuring the TS agent

Configuring FSSOwith Novell networks
You need to configure the eDirectory agent for it to communicate with eDirectory servers. You may have provided
some of this information during installation.

This section includes:

l Configuring the eDirectory agent
l Adding an eDirectory server
l Configuring a group filter

Configuring the eDirectory agent

You need to configure the eDirectory agent for it to communicate with eDirectory servers.

To configure the eDirectory agent:

1. From the Start menu select Programs > Fortinet > eDirectory Agent > eDirectory Config Utility.
2. The eDirectory Agent Configuration Utility dialog opens. Enter the following information and select OK.
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eDirectory Authentication

Username Enter a username that has access to the eDirectory, using LDAP format.

Password Enter the password.

Listening port Enter the TCP port on which Fortinet Single Sign On Agent listens for
connections from FortiGate units. The default is 8000. You can change the
port if necessary.

Refresh interval Enter the interval in seconds between polls of the eDirectory server to
check for new logons. The default is 30 seconds.

FortiGate Connection Authentication

Require authenticated
connection from FortiGate

Select to require the FortiGate unit to authenticate before connecting to
the eDirectory Agent.

Password Enter the password that FortiGate units must use to authenticate. The
maximum password length is 15 characters. The default password is
“FortinetCanada”.

User logon Info Search
Method

Select how the eDirectory agent accesses user logon information: LDAP or
Native (Novell API). LDAP is the default.

If you select Native, you must also have the Novell Client installed on the
PC.

Logging

Log file size limit (MB) Enter the maximum size for the log file in MB.

View Log View the current log file.

Dump Session List the currently logged-on users in the log file. This can be useful for
troubleshooting.

Log level Select Debug, Info,Warning or Error as the minimum severity level of
message to log or select None to disable logging.

eDirectory Server List

Add Add an eDirectory server. See Adding an eDirectory server on page 536.

Delete Delete the selected eDirectory server.

Edit Modify the settings for the selected server.

Set Group Filters... Select the user groups whose user logons will be reported to the FortiGate
unit. This is used only if user groups are not selected on the FortiGate unit.
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Adding an eDirectory server

Once the eDirectory agent is configured, you add one or more eDirectory servers.

To add an eDirectory server:

1. In the eDirectory Agent Configuration Utility dialog box (see the preceding procedure, Configuring the eDirectory
agent), select Add.

2. The eDirectory Setup dialog box opens. Enter the following information and select OK:

eDirectory Server Address Enter the IP address of the eDirectory server.

Port If the eDirectory server does not use the default port 389, clear the
Default check box and enter the port number.

Use default credential
Select to use the credentials specified in the eDirectory Configuration
Utility. See Configuring the eDirectory agent on page 534. Otherwise,
leave the check box clear and enter a username and Password below.

User name Enter a username that has access to the eDirectory, using LDAP format.

User password Enter the password.

Use secure connection (SSL) Select to connect to the eDirectory server using SSL security.

Search Base DN Enter the base Distinguished Name for the user search.

Configuring a group filter

The eDirectory agent sends user logon information to the FortiGate unit for all user groups unless you either
configure an LDAP server entry for the eDirectory on the FortiGate unit and select the groups that you want to
monitor or configure the group filter on the eDirectory agent.

If both the FortiGate LDAP configuration and the eDirectory agent group filter are present, the FortiGate user
group selections are used.

To configure the group filter:

1. From the Start menu select Programs > Fortinet > eDirectory Agent > eDirectory Config Utility.
2. Select Set Group Filters.
3. Do one of the following:

l Enter group names, then select Add.
l Select Advanced, select groups, and then select Add.

4. Select OK.

Configuring FSSO Advanced Settings
Depending on your network topologies and requirement, you may need to configure advanced settings in the
FSSO Colloctor agent.To do so, from the Start menu, select Programs > Fortinet > Fortinet Single Sign-On
Agent > Configure Fortinet Single Sign-On Agent, then from the Common Tasks section, select
Advanced Settings.

This section include :
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l General Settings
l Citrix/Terminal Server
l Exchange Server
l RADIUS Accounting

General Settings

In the General tab, enter the following information and select OK.

Worker thread count Number of threads started in the CA process. Default is128 on CA version
5.0.0241.

Maximum FortiGate
connections Number of FortiGates can be connected to the CA. Default is 64.

Group look-up interval The interval in seconds to lookup users/groups. If an AD group membership
of currently logged on user, CA can detect this and update information on the
FortiGate. Enter 0 for no checking.

Windows security Event logs Choose the event logs to poll.

Event IDs to poll 0:Default set, it includes Kerberos authentication event logs : 672 for
Windows server 2003, 4768 for Windows server 2008 and 2012 and NTLM
authentication event logs : 680 for Windows server 2003, 4776 for Windows
server 2008 and 2012. 1: Extended set, it includes Kerberos service ticket
event logs : 673 for Windows server 2003, 4769 for Windows server 2008 and
2012. Service tickets are obtained whenever a user or computer accesses a
server on the network.
List the event ids separated by ";".

 Workstation Check Optionally enable Use WMI to check user logoff for the collector agent to
query whether users is still logged on.

Workstation Name Resolution
Advance Options

Alternative DNS server(s)
Collector Agent uses the DNS server configured on the machine it is running
on by default. If CA should use another DNS server then one or more
alternative DNS server can be configured here.

Alternative workstation
suffix(es) If only host name is available CA uses the default domain suffix to build a

FQDN for DNS queries. In case CA should use a different suffix, it can be
configured as well.
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Citrix/Terminal Server

In the Citrix/Terminal Server tab, enter the following information and select OK.

Support Citrix/Terminal Server
Virtual IP Environment

When Citrix server are configured with VIP, CA can get user logon events
from theses server. Citrix changed their interface and data format so version
of Citrix server is important.

Citrix server before
version 6.0 Enable this option if you Citrix server version is before 6.0.

Server list Enter the list of servers separated by colon.

Citrix server version
6.0 or later, or Terminal
Server

Enable this option if you Citrix server version is 6.0 or later.

Server list Enter the list of servers separated by colon.
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Exchange Server

FSSO supports monitoring Microsoft Exchange Server. This is useful for situation that the user use the domain
account to access their email, but client device might or might not be in the domain. Support for Exchange server
is configured on the Back-end FSSO collector agent underAdvanced Settings >Exchange Server.

Select Add and enter the following information and select OK.

Domain Name Enter your domain name.

Server IP/Hostname Enter the IP address or the hostname of your exchange server.

Polling forwarded event
log

This option for scenarios when you do not want that CA polls the Exchange Server
logs directly. In this case you need to configure event log forwarding on the
Exchange server. Exchange event logs can be forwarded to any member server.
If you enable this, instead of the IP of the Exchange server configured in the
previous step, you must then configure the IP of this member server. CA will then
contact the member server.

Ignore Name

Because CAwill also checkWindows log files for logon events and when a user
authenticates to Exchange Server there is also a logon event in Windows event log,
which CAwill read and this will overwrite the Exchange Server logon event (ES-
EventLog) on CA. So it is recommended to set the ignore list to the domain the user
belongs to.
To do so, enter the domain name in the Ignore Name field and select Add.
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RADIUS Accounting

ARADIUS server must be configured in your network to send accounting messages to the Collector Agent which
can be configured to work with most RADIUS-based accounting systems. In most cases, you only need to do the
following to your RADIUS accounting system:

l Add a user group name field to customer accounts on the RADIUS server so that the name is added to the RADIUS
Start record sent by the accounting system to the Collector Agent. User group names do not need to be added for
all users, only to the accounts of users who will use RADIUS Accounting feature on the Collector Agent.

l Configure your accounting system to send RADIUS Start records to the Collector Agent.

The Collocter Agent should be configured to listen for RADIUS accounting messages as following.

RADIUS Accounting Server

Enable RADIUS
Accounting Server

Enable this option to allow the CA to gather information about authenticated
users via a RADIUS server and send these information to the FortiGate unit
for monitoring.

Listen port The port on which CA listens for RADIUS accounting messages. Default
RADIUS accounting is 1813, but if RADIUS server sends accounting
messages on different port, value can be configured here.

Shared secret Common secret between CA and RADIUS server.
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Default domain name This should be the AD domain for which this CA is configured. In this case
user name in RADIUS accounting message can be in simple format like
user1.

If this value is empty, then user name in RADIUS accounting message must
be in one of these formats user1@domain, Domain\user1 or
domain/user1.

CA will use user name and domain to query group membership of user. Client
IP address (Framed IP) should also be in RADIUS accounting message, so
that CA can forward user name, IP address and groups to the FortiGate.

Configuring FSSO on FortiGate units
To configure your FortiGate unit to operate with agent-based FSSO, you

l Configure any access to LDAP servers that might be necessary. Skip this step if you are using FSSO Standard
mode. See Configuring LDAP server access on page 541.

l Specify the Collector agent or Novell eDirectory agent that will provide user logon information. See Specifying your
Collector agents or Novell eDirectory agents on page 543.

l Add Active Directory user groups to FortiGate user groups. See Creating Fortinet Single Sign-On (FSSO) user
groups on page 544.

l Create security policies for FSSO-authenticated groups. See Creating security policies on page 545.
l Optionally, specify a guest security policy to allow guest access. See Enabling guest access through FSSO security

policies on page 546.

Configuring LDAP server access

LDAP access is required if your network has a Novell eDirectory agent or a Collector agent using Windows
Advanced AD access mode. If you are using FSSO Standard mode, go to Specifying your Collector agents or
Novell eDirectory agents on page 543.

1. Go to User & Device > LDAP Servers and select Create New.
2. Enter the Server IP/Name and Server Port (default 389).
3. In the Common Name Identifier field, enter sAMAccountName.The default common name identifier is cn.

This is correct for most LDAP servers. However some servers use other identifiers such as uid.
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4. In the Distinguished Name field, enter your organization distinguished name. In this example, Distinguished
Name is dc=techdoc,dc=local

5. Select Fetch DN, this will fetch the Windows AD directory.

6. Set Bind Type to Regular.
7. In the User DN field, enter the administrative account name that you created for FSSO.

For example, if the account is administrator, enter “administrator@techdoc.local”.

8. Enter the administrative account password in the Password field.
9. Optionally select Secure Connection.

l In the Protocol field, select LDAPS or STARTTLS.
l In the Certificate field, select the appropriate certificate for authentication.

Note that you need to configure the Windows AD for secure connection accordingly.

10. Select OK.
11. Test your configuration by selecting the Test button. A successful message confirming the right settings appears.
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To configure LDAP for FSSO - CLI example:

config user ldap
edit LDAP

set server 10.10.20.3
set cnid sAMAccountName
set dn dc=techdoc,dc=local
set type regular
set username administrator@techdoc.local
set password <your_password>

next
end

Specifying your Collector agents or Novell eDirectory agents

You need to configure the FortiGate unit to access at least one Collector agent or Novell eDirectory agent. You
can specify up to five servers on which you have installed a Collector or eDirectory agent. The FortiGate unit
accesses these servers in the order that they appear in the list. If a server becomes unavailable, the next one in
the list is tried.

To specify Collector agents - web-based manager:

1. Go to User & Device > Single Sign-On and select Create New.
2. In Type, select Fortinet Single-Sign-On Agent.
3. Enter a Name for the Windows AD server. This name appears in the list of Windows AD servers when you create

user groups.
4. Enter the following information for each of up to five collector agents and select OK:

Agent IP/Name Enter the IP address or the name of the server where this agent is installed.
Maximum name length is 63 characters.

If the TCP port used for FSSO is not the default, 8000, you can change the
setting in the CLI using the config user fsso command.

See Configuring Collector agent settings on page 523.

Password Enter the password for the Collector agent or eDirectory agent. For the
Collector agent, this is required only if you configured the agent to require
authenticated access.

5. For Novell eDirectory or Windows AD with Collector agent in Advanced AD access mode select the LDAP Server
you configured previously. See Configuring LDAP server access on page 541.

6. In Users/Groups, select the Users orGroups orOrganizational Units tab and then select the users or groups
or OU that you want to monitor.

7. Select OK.
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To specify the FSSO Collector agent - CLI:

In this example, the SSO server name is techdoc and the LDAP server is LDAP.

config user fsso
edit techdoc

set ldap-server LDAP
set password <your_password>
set server 10.10.20.3
set port 8000

end

Creating Fortinet Single Sign-On (FSSO) user groups

You cannot use Windows or Novell groups directly in FortiGate security policies. You must create FortiGate user
groups of the FSSO type and add Windows or Novell groups to them.

To create a user group for FSSO authentication - web-based manager:

1. Go to User & Device > User Groups.
2. Select Create New.

The New User Group dialog box opens.
3. In the Name box, enter a name for the group, FSSO_Internet_users for example.
4. In Type, select Fortinet Single Sign-On (FSSO).
5. InMembers, select the required FSSO groups.
6. Select OK.

To create the FSSO_Internet-users user group - CLI :

config user group
edit FSSO_Internet_users

set group-type fsso-service
set member CN=Engineering,cn=users,dc=office,dc=example,dc=com

CN=Sales,cn=users,dc=office,dc=example,dc=com
end
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Creating security policies

Policies that require FSSO authentication are very similar to other security policies. Using identity-based policies,
you can configure access that depends on the FSSO user group. This allows each FSSO user group to have its
own level of access to its own group of services

In this situation, Example.com is a company that has its employees and authentication servers on an internal
network. The FortiGate unit intercepts all traffic leaving the internal network and requires FSSO authentication to
access network resources on the Internet. The following procedure configures the security policy for FSSO
authentication. FSSO is installed and configured including the RADIUS server, FSSO Collector agent, and user
groups on the FortiGate

For the following procedure, the internal interface is port1 and the external interface connected to the Internet
is port2. There is an address group for the internal network called company_network. The FSSO user group
is called fsso_group, and the FSSO RADIUS server is fsso_rad_server.

To configure an FSSO authentication security policy - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information.

Incoming Interface port1

Source Address company_network

Source User(s) fsso_group

Outgoing Interface port2

Destination Address all

Schedule always

Service HTTP, HTTPS, FTP, and Telnet

Action ACCEPT

NAT ON

UTM Security Profiles ON for AntiVirus, IPS, Web Filter, and Email Filter, all using default
profiles.

Log Allowed Traffic ON. Select Security Events.

3. Select OK.
4. Ensure the FSSO authentication policy is higher in the policy list than more general policies for the same

interfaces.

To create a security policy for FSSO authentication - CLI:

config firewall policy
edit 0

set srcintf port1
set dstintf port2
set srcaddr company_network
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set dstaddr all
set action accept
set groups fsso_group
set schedule always
set service HTTP HTTPS FTP TELNET
set nat enable

end

Here is an example of how this FSSO authentication policy is used. Example.com employee on the internal
company network logs on to the internal network using their RADIUS username and password. When that user
attempts to access the Internet, which requires FSSO authentication, the FortiGate authentication security policy
intercepts the session, checks with the FSSO Collector agent to verify the user’s identity and credentials, and
then if everything is verified the user is allowed access to the Internet.

Users belonging to multiple groups

Before FSSO 4.0 MR3, if a user belonged to multiple user groups, the first security policy to match any group that
user belonged too was the only security policy applied. If that specific group did not have access to this protocol or
resource where another group did, the user was still denied access. For example, test_user belongs to
group1 and group2. There are two FSSO authentication policies— one matches group1 to authenticate FTP
traffic and one matches group2 to authenticate email traffic. The group1 policy is at the top of the list of
policies. If test_user wants to access an email server, the first policy encountered for a group test_user
belongs to is the group1 policy which does not allow email access and test_user is denied access. This is
despite the next policy allowing access to email. If the order was reversed in this case, the traffic would be
matched and the user’s traffic would be allowed through the firewall. However if the policy order was reversed,
FTP traffic would not be matched.

As of FSSO 4.0 MR3, if a user belongs to multiple groups multiple then attempts to match the group are
attempted if applicable. Using the above example, when the attempt to match the group1 policy is made and
fails, the next policy with a group that test_user is a member of is attempted. In this case, the next policy is
matched and access is granted to the email server.

When configuring this example the only difference between the policies is the services that are listed and the
FSSO user group name.

Authenticating through multiple groups allows administrators to assign groups for specific services, and users
who are members of each group have access to those services. For example there could be an FTP group, an
email group, and a Telnet group.

Enabling guest access through FSSO security policies

You can enable guest users to access FSSO security policies. Guests are users who are unknown to the Windows
AD or Novell network and servers that do not logon to a Windows AD domain.

To enable guest access in your FSSO security policy, add an identity-based policy assigned to the built-in user
group SSO_Guest_Users. Specify the services, schedule and protection profile that apply to guest users—
typically guests receive reduced access to a reduced set of services.

IPv6 support for FSSO

FortiGate FSSO supports connecting to an FSSO agent over IPv6 and collecting and sending IPv6 details about
endpoints. This is enforced in the same manner as IPv4 FSSO traffic.
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Syntax

config user fsso
edit <fsso agent name>
set source-ip6 <IPv6 address for source>

end

FortiOS FSSO log messages
There are two types of FortiOS log messages— firewall and event. FSSO-related log messages are generated
from authentication events. These include user logon and log off events, and NTLM authentication events. These
log messages are central to network accounting policies, and can also be useful in troubleshooting issues. For
more information on firewall logging, see "Enabling security logging". For more information on logging, see the
FortiOS Handbook Log and Reporting guide.

Enabling authentication event logging

For the FortiGate unit to log events, that specific type of event must be enabled under logging.

When VDOMs are enabled certain options may not be available, such as CPU and memory usage events. You
can enable event logs only when you are logged on to a VDOM; you cannot enable event logs globally.

To ensure you log all the events need, set the minimum log level to Notification or Information. Firewall logging
requires Notification as a minimum. The closer to Debug level, the more information will be logged. While this
extra information is useful, you must

To enable event logging:

1. Go to Log & Report > Log Settings.
2. In Event Logging, select:

System activity event All system-related events, such as ping server failure and gateway status.

User activity event All administration events, such as user logins, resets, and configuration
updates.

3. Optionally you can enable any or all of the other logging event options.
4. Select Apply.

Authentication log messages
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List of FSSO related log messages

Message ID Severity Description

43008 Notification Authentication was successful

43009 Notification Authentication session failed

43010 Warning Authentication locked out

43011 Notification Authentication timed out

43012 Notification FSSO authentication was successful

43013 Notification FSSO authentication failed

43014 Notification FSSO user logged on

43015 Notification FSSO user logged off

43016 Notification NTLM authentication was successful

43017 Notification NTLM authentication failed

For more information on logging, see the FortiOS Handbook Log and Reporting guide.

Using filters

Logon events are detected by the FSSO CA by monitoring the Security Event logs. Additional logon event filters,
such as ServiceName and ServiceID, have been implemented so as to avoid instances of conflicting security
events, where existing FSSO logon user information could be overwritten and impact user connectivity.

The problem arises when a scenario such as the following occurs:

1. User1 logs on to PC1 on 1.1.1.1, which is logged as a successful Kerberos logon event with an ID of 4769.
2. The FortiGate creates an authenticated FSSO user log entry forUser1/1.1.1.1.
3. User1 then maps a network drive and uses credentials forUser2 to logon to the same PC (PC1).
4. The FortiGate sees this as a separate logon to PC1 by a new user, User2. As a result, the log entry is updated to

User2/1.1.1.1.
5. If User2 is a member of a different user group to User1 (i.e. has different access permissions), User1 could lose

access to their network resources.
The new filter makes the CA ignore the event log created when User1mapped a network drive, meaning that the
original entry forUser1will not be changed.

While this is a useful feature, it is highly recommended to test filters in a redundant
test environment.
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Testing FSSO
Once FSSO is configured, you can easily test to ensure your configuration is working as expected. For additional
FSSO testing, see Troubleshooting FSSO on page 549.

1. Logon to one of the stations on the FSSO domain, and access an Internet resource.
2. Connect to the CLI of the FortiGate unit, and if possible log the output.
3. Enter the following command:

diagnose debug authd fsso list

4. Check the output. If FSSO is functioning properly you will see something similar to the following:
----FSSO logons----
IP: 10.10.20.3 User: ADMINISTRATOR Groups: CN=FORTIOS WRITERS,CN=USERS,DC=TECHDOC,DC=LOCAL

Workstation: WIN2K8R2.TECHDOC.LOCAL MemberOf: FortiOS_Writers
IP: 10.10.20.7 User: TELBAR Groups: CN=FORTIOS WRITERS,CN=USERS,DC=TECHDOC,DC=LOCAL

Workstation: TELBAR-PC7.TECHDOC.LOCAL
Total number of logons listed: 2, filtered: 0
----end of FSSO logons----

The exact information will vary based on your installation.

5. Check the FortiGate event log, for FSSO-auth action or other FSSO related events with FSSO information in the
message field.

6. To check server connectivity, run the following commands from the CLI:
FGT# diagnose debug enable
FGT# diagnose debug authd fsso server-status
FGT# Server Name Connection Status Version
     ----------- ----------------- -------
     techdoc connected FSSO 5.0.0241

Troubleshooting FSSO
When installing, configuring, and working with FSSO some problems are quite common. A selection of these
problems follows including explanations and solutions.

Some commonWindows AD problems include:

l General troubleshooting tips for FSSO
l Users on a particular computer (IP address) cannot access the network
l Guest users do not have access to network
l Can’t find the DCagent service
l User logon events not received by FSSO Collector agent
l Mac OS X users can’t access external resources after waking from sleep mode

General troubleshooting tips for FSSO

The following tips are useful in many FSSO troubleshooting situations.

l Ensure all firewalls are allowing the FSSO required ports through.
FSSO has a number of required ports that must be allowed through all firewalls or connections will fail. These
include: ports 139, 389 (LDAP), 445, 636 (LDAP) 8000, and 8002.

l Ensure the Collector agent has at least 64kbps bandwidth to the FortiGate unit.
If not the Collector agent does not have this amount of bandwidth, information FSSO information may not reach
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the FortiGate unit resulting in outages. The best solution is to configure traffic shaping between the FortiGate unit
and the Collector agent to ensure that minimum bandwidth is always available.

Users on a particular computer (IP address) cannot access the network

Windows AD Domain Controller agent gets the username and workstation where the logon attempt is coming
from. If there are two computers with the same IP address and the same user trying to logon, it is possible for the
authentication system to become confused and believe that the user on computer_1 is actually trying to access
computer_2.

Windows AD does not track when a user logs out. It is possible that a user logs out on one computer, and
immediate logs onto a second computer while the system still believes the user is logged on the original
computer. While this is allowed, information that is intended for the session on one computer may mistakenly end
up going to the other computer instead. The result would look similar to a hijacked session.

Solutions

l Ensure each computer has separate IP addresses.
l Encourage users to logout on one machine before logging onto another machine.
l If multiple users have the same username, change the usernames to be unique.
l Shorten timeout timer to flush inactive sessions after a shorter time.

Guest users do not have access to network

A group of guest users was created, but they don’t have access.

Solution

The group of the guest users was not included in a policy, so they do not fall under the guest account. To give
them access, associate their group with a security policy.

Additionally, there is a default group called SSO_Guest_Users. Ensure that group is part of an identity-based
security policy to allow traffic.

Can’t find the DCagent service

The DCagent service can’t be found in the list of regular windows services. This is because it has no associated
Windows service.

Instead DCagent is really dcagent.dll and is located in the Windows\system32 folder. This DLL file is
loaded when windows boots up and it intercepts all logon events processed by the domain controller to send
these events to the Collector agent (CA).

Solution

To verify that the DCagent is installed properly

1. Check that DCagent.dll exists in Windows\system32 folder.
2. Check that the registry key exists: [HKEY_LOCAL_MACHINE\SOFTWARE\Fortinet\FSAE\dcagent]
If both exist, the DCagent is properly installed.
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User logon events not received by FSSO Collector agent

When a warning dialog is present on the screen on the Collector agent computer, the Collector agent will not
receive any logon events. Once the dialog has been closed normal operation will resume.

If polling mode is enabled, it is possible the polling interval is too large. Use a shorter polling interval to ensure the
collector agent is capturing all logon events.

The polling interval can only be adjusted using the firewall-embedded agent itself, not
on agents deployed to member servers.

If NetAPI polling mode is enabled, consider switching to Event logs or Event Logs using WMI polling as it provides
better accuracy.

Mac OS X users can’t access external resources after waking from sleep mode

When client computers running Mac OS X (10.6.X and higher) wake up from sleep mode, the user must
authenticate again to be able to access external resources. If the user does not re-authenticate, the user will
maintain access to internal web sites, but will be unable to access any external resources.

This issue is caused by Mac OS X not providing sufficient information to the FSSO. This results in the FortiGate
blocking access to the user because they cannot be authenticated.

Solution

The security settings on client computer(s) must be configured to require that a username and password be
entered when exiting sleep mode or screen saver. With this feature enabled in Mac OS X, the FortiGate will
receive the authentication information it requires to authenticate the user and allow them access.

Note that if the user reverts their settings to disable the password requirement, this will cause the issue to
reappear.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

551



SSO using RADIUS accounting records

A FortiGate unit can authenticate users transparently who have already authenticated on an external RADIUS
server. Based on the user group to which the user belongs, the security policy applies the appropriate UTM
profiles. RADIUS SSO is relatively simple because the FortiGate unit does not interact with the RADIUS server, it
only monitors RADIUS accounting records that the server forwards (originating from the RADIUS client). These
records include the user’s IP address and user group.

After the initial set-up, changes to the user database, including changes to user group memberships, are made
on the external RADIUS server, not on the FortiGate unit.

This section describes:

l User’s view of RADIUS SSO authentication
l Configuration Overview
l Configuring the RADIUS server
l Creating the FortiGate RADIUS SSO agent
l Defining local user groups for RADIUS SSO
l Creating security policies
l Example: webfiltering for student and teacher accounts

User’s view of RADIUS SSO authentication
For the user, RADIUS SSO authentication is simple:

l The user connects to the RADIUS server and authenticates.
l The user attempts to connect to a network resource that is reached through a FortiGate unit. Authentication is

required for access, but the user connects to the destination without being asked for logon credentials because the
FortiGate unit knows that the user is already authenticated. FortiOS applies UTM features appropriate to the user
groups that the user belongs to.

Configuration Overview
The general steps to implement RADIUS Single Sign-On are:

1. If necessary, configure your RADIUS server. The user database needs to include user group information and the
server needs to send accounting messages.

2. Create the FortiGate RADIUS SSO agent.
3. Define local user groups that map to RADIUS groups.
4. Create a security policy which specifies the user groups that are permitted access.

Configuring the RADIUS server
You can configure FortiGate RSSO to work with most RADIUS-based accounting systems. In most cases, you
only need to do the following to your RADIUS accounting system:

l Add a user group name field to customer accounts on the RADIUS server so that the name is added to the RADIUS
Start record sent by the accounting system to the FortiOS unit. User group names do not need to be added for all
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users, only to the accounts of users who will use RSSO feature on the FortiGate unit.
l Configure your accounting system to send RADIUS Start records to the FortiOS unit. You can send the RADIUS

Start records to any FortiGate network interface. If your FortiGate unit is operating with virtual domains (VDOMs)
enabled, the RADIUS Start records must be sent to a network interface in the management VDOM.

IPv6 RADIUS Support

RADIUS authentication is supported with IPv6, allowing administrators to configure an IPv6 RADIUS server on
the FortiGate for IPv6 RADIUS authentication traffic to pass between the server and FortiGate.

Note that while you can set the primary RADIUS server's IPv6 address, the source IP
address for communications to the RADIUS server cannot be configured as IPv6.

Syntax

Allow IPv6 access on an interface:

config system interface
edit <name>

config ipv6
set ip6-allowaccess {ping | https | ssh | snmp | http | telnet | fgfm | capwap}
set ip6-address <xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx/xxx>

next
next

end

Configure the IPv6 RADIUS server:

config user radius
edit <name>

set server <xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx>
...

next
end

Creating the FortiGate RADIUS SSO agent
Once you define a RADIUS SSO (RSSO) agent, the FortiGate unit will accept user logon information from any
RADIUS server that has the same shared secret. You can create only one RSSO agent in each VDOM.

Before you create the RSSO agent, you need to allow RADIUS accounting information on the interface that
connects to the RADIUS server.

To enable RADIUS access on the interface - web-based manager:

1. Go to Network > Interfaces and edit the interface to which the RADIUS server connected.
2. Select Listen for RADIUS Accounting Messages.
3. Select OK.

To enable RADIUS access on the interface - CLI:

In this example, the port2 interface is used.
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config system interface
edit port2

set allowaccess radius-acct
end

To create a RADIUS SSO agent:

1. Go to User & Device > Single Sign-On and select Create New.
2. In Type, select RADIUS Single-Sign-On Agent.
3. Select Use RADIUS Shared Secret and enter the RADIUS server shared secret.
4. Select Send RADIUS Responses.
5. Select OK.

To create a RADIUS SSO agent - CLI

config user radius
edit RSSO_Agent

set rsso enable
set rsso-validate-request-secret enable
set rsso-secret <your secret>
set rsso-radius-response enable

end

Selecting which RADIUS attributes are used for RSSO

For RADIUS SSO to work, FortiOS needs to know the user’s endpoint identifier (usually IP address) and RADIUS
user group. There are default RADIUS attributes where FortiOS expects this information, but you can change
these attributes in the config user radius CLI command.

RSSO information and RADIUS attribute defaults

RSSO Information RADIUS Attribute CLI field

Endpoint user IP Framed-IP-Address rsso-endpoint-attribute

Endpoint identifier Calling-Station-ID rsso-endpoint-attribute

Endpoint block attribute Called-Station-ID rsso-endpoint-block-
attribute

User group Class sso-attribute

User Prefix delegated-IPv6-prefix

User Prefix framed-IPv6-prefix

The Endpoint block attribute can be used to block or allow a user. If the attribute value is set to the name of an
attribute that indicates whether to block or allow, FortiOS blocks or allows respectively all traffic from that user’s
IP address. The RSSO fields are visible only when rsso is set to enable.
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The Prefix attributes allow for RSSO to provide a /56 prefix for DSL customers. All devices connected from the
same location (/56 per subscriber) can be mapped to the same profile without the need to create multiple /64 or
smaller entries.

Override SSO attribute

Prior to FortiOS 5.4, when receiving a new start message with a different group name for the same user, and a
different IP address such as for a roaming mobile device, the original process was to override all group name
information to the latest group name received from the latest start message.

You can disable this override when needed. The default behavior keeps the original design.

To enable or disable overriding SSO attribute - CLI

config user radius
edit <name>

set rsso <enable>
set sso-attribute-value-override {enable | disable} Enable/disable override of old attribute

value with new value for the same endpoint.

Configuring logging for RSSO

In the config user radius CLI command, you can set the following flags in the rsso-log-flags field to
determine which types of RSSO-related events are logged:

l protocol-error— ARADIUS protocol error occurred.
l profile-missing— FortiOS cannot find a user group name in a RADIUS start message that matches the

name of an RSSO user group in FortiOS.
l accounting-stop-missed— a user context entry expired without FortiOS receiving a RADIUS Stop message.
l accounting-event— FortiOS did not find the expected information in a RADIUS record.
l endpoint-block— FortiOS blocked a user because the RADIUS record’s endpoint block attribute had the value

“Block”.
l radiusd-other—Other events, described in the log message.

Defining local user groups for RADIUS SSO
You cannot use RADIUS user groups directly in security policies. Instead, you create locally-defined user groups
on the FortiGate unit and associate each of them with a RADIUS user group.

To define local user groups for RADIUS SSO:

1. Go to User & Device > User Groups and select Create New.
2. Enter a Name for the user group.
3. In Type, select RADIUS Single Sign-On (RSSO).
4. In RADIUS Attribute Value, enter the name of the RADIUS user group this local user group represents.
5. Select OK.

To define local user groups for RADIUS SSO:

This example creates an RSSO user group called RSSO-1 that is associated with RADIUS user group “student”.

config user group
edit RSSO-1
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set group-type rsso
set sso-attribute-value student

end

Creating security policies
RADIUS SSO uses regular identity-based security policies. The RSSO user group you specify determines which
users are permitted to use the policy. You can create multiple policies if user groups can have different UTM
features enabled, different permitted services, schedules, and so on.

To create a security policy for RSSO - web-based manager:

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Enter the following information.

Incoming Interface as needed

Source Address as needed

Source User(s) Select the user groups you created for RSSO. See Defining local user
groups for RADIUS SSO on page 555.

Outgoing Interface as needed

Destination Address all

Schedule as needed

Service as needed

Action ACCEPT

Enable NAT Selected

Security Profiles Select security profiles appropriate for the user group.

4. Select OK.

To ensure an RSSO-related policy is matched first, the policy should be placed higher in the security policy list
than more general policies for the same interfaces.

5. Select OK.

To create a security policy for RSSO - CLI:

In this example, an internal network to Internet policy enables web access for members of a student group and
activates the appropriate UTM profiles.

config firewall policy
edit 0

set srcintf internal
set dstintf wan1
set srcaddr all
set dstaddr "all"
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set action accept
set rsso enable
set groups "RSSO-student"
set schedule always
set service HTTP HTTPS
set nat enable
set utm-status enable
set av-profile students
set webfilter-profile students
set spamfilter-profile students
set dlp-sensor default
set ips-sensor default
set application-list students
set profile-protocol-options "default"

end

Example: webfiltering for student and teacher accounts
The following example uses RADIUS SSO to apply web filtering to students, but not to teachers. Assume that the
RADIUS server is already configured to send RADIUS Start and Stop records to the FortiGate unit. There are two
RADIUS user groups, students and teachers, recorded in the default attribute Class. The workstations are
connected to port1, port2 connects to the RADIUS server, and port3 connects to the Internet.

Configure the student web filter profile:

1. Go to Security Profiles > Web Filter and select Create New (the “+” button).
2. Enter the following and select OK.

Name student

Inspection Mode Proxy

FortiGuard Categories Enable. Right-click the Potentially Liable category and select Block.
Repeat forAdult/Mature Content and Security Risk.

Create the RADIUS SSO agent:

1. Go to User & Device > Single Sign-On and select Create New.
2. In Type, select RADIUS Single-Sign-On.
3. Select Use RADIUS Shared Secret and enter the RADIUS server shared secret.
4. Select Send RADIUS Responses.
5. Select OK.

Define local user groups associated with the RADIUS SSO user groups:

1. Go to User & Device > User Groups and select Create New.
2. Enter the following and select OK.

Name RSSO-students
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Type RADIUS Single Sign-On (RSSO)

RADIUS Attribute Value students

3. Select Create New, enter the following and select OK.

Name RSSO-teachers

Type RADIUS Single Sign-On (RSSO)

RADIUS Attribute Value teachers

Create a security policy for students:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter

Incoming Interface port1

Source Address all

Source User(s) RSSO-students

Source Device Type All

Outgoing Interface port3

Destination Address all

Schedule always

Service HTTP, HTTPS

Action ACCEPT

NAT ON

Security Profiles Enable AntiVirus, Web Filter, IPS.

In Web Filter, select the student profile.

3. Select OK.

Create a security policy for teachers:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter

Incoming Interface port2

Source Address all
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Source User(s) RSSO-teachers

Source Device Type All

Outgoing Interface port3

Destination Address all

Schedule always

Service ALL

Action ACCEPT

NAT ON

Security Profiles Enable AntiVirus and IPS.

3. Select OK.
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This section describes how to view lists of currently logged-in firewall and VPN users. It also describes how to
disconnect users.

The following topics are included in this section:

l Monitoring firewall users
l Monitoring SSL VPN users
l Monitoring IPsec VPN users
l Monitoring users Quarantine

Monitoring firewall users
To monitor firewall users, go toMonitor > Firewall User Monitor.

You can de-authenticate a user by selecting the Delete icon for that entry.

You can filter the list of displayed users by selecting the funnel icon for one of the column titles or selecting Filter
Settings.

Optionally, you can de-authenticate multiple users by selecting them and then selecting De-authenticate.

Monitoring SSL VPN users
You can monitor web-mode and tunnel-mode SSL VPN users by username and IP address.

To monitor SSL VPN users, go toMonitor > SSL-VPN Monitor. To disconnect a user, select the user and then
select the Delete icon.

The first line, listing the username and IP address, is present for a user with either a web-mode or tunnel-mode
connection. The Subsession line is present only if the user has a tunnel mode connection. The Description
column displays the virtual IP address assigned to the user’s tunnel-mode connection.

For more information about SSL VPN, see the FortiOS Handbook SSL VPN guide.

To monitor SSL VPN users - CLI:

To list all of the SSL VPN sessions and their index numbers:

execute vpn sslvpn list
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The output looks like this:

SSL-VPN Login Users:
 Index   User   Auth Type   Timeout         From      HTTPS in/out
 0       user1  1           256       172.20.120.51   0/0

SSL-VPN sessions:
 Index   User   Source IP        Tunnel/Dest IP
 0       user2  172.20.120.51    10.0.0.1

You can use the Index value in the following commands to disconnect user sessions:

To disconnect a tunnel-mode user

execute vpn sslvpn del-tunnel <index>

To disconnect a web-mode user

execute vpn sslvpn del-web <index>

You can also disconnect multiple users:

To disconnect all tunnel-mode SSL VPN users in this VDOM

execute vpn ssl del-all tunnel

To disconnect all SSL VPN users in this VDOM

execute vpn ssl del-all

Monitoring IPsec VPN users
To monitor IPsec VPN tunnels in the web-based manager, go toMonitor > IPsec Monitor. user names are
available only for users who authenticate with XAuth.

You can close a tunnel by selecting the tunnel and right click to select Bring Down.

For more information, see the FortiOS Handbook IPsec VPN guide.

Monitoring users Quarantine
The User Quarantine list shows all IP addresses and interfaces blocked by NAC quarantine. The list also shows
all IP addresses, authenticated users, senders, and interfaces blocked by Data Leak Prevention (DLP). The
system administrator can selectively release users or interfaces from quarantine or configure quarantine to expire
after a selected time period.

All sessions started by users or IP addresses on the User Quarantine list are blocked until the user or IP address is
removed from the list. All sessions to an interface on the list are blocked until the interface is removed from the
list.

You can configure NAC quarantine to add users or IP addresses to the User Quarantine list under the following
conditions:
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l Users or IP addresses that originate attacks detected by IPS - To quarantine users or IP addresses that
originate attacks, enable and configureQuarantine in an IPS Filter.

l Users or IP addresses that are quarantined by Data Leak Prevention - In a DLP sensor select Quarantine
IP Address as the action to take.

For more information, see FortiOS Handbook Security Profiles guide.

Users are viewed from Monitor > Quarantine Monitor.

Delete Removes the selected user or IP address from the User Quarantine list.

Remove All Removes all users and IP addresses from the User Quarantine list.

Search Search the list for a particular IP address.

Source The FortiGate function that caused the user or IP address to be added to the User
Quarantine list: IPS or Data Leak Prevention.

Created The date and time the user or IP address was added to the Banned User list.

Expires
The date and time the user or IP address will be automatically removed from the User
Quarantine list. If Expires is Indefinite, you must manually remove the user or host
from the list.
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This chapter provides an example of a FortiGate unit providing authenticated access to the Internet for both
Windows network users and local users.

The following topics are included in this section:

l Firewall authentication example
l LDAPDial-in using member-attribute example
l RADIUS SSO example
l Troubleshooting

Firewall authentication example

Example configuration

Overview

In this example, there is a Windows network connected to Port 2 on the FortiGate unit and another LAN,
Network_1, connected to Port 3.

All Windows network users authenticate when they logon to their network. Members of the Engineering and Sales
groups can access the Internet without entering their authentication credentials again. The example assumes
that the Fortinet Single Sign On (FSSO) has already been installed and configured on the domain controller.

LAN users who belong to the Internet_users group can access the Internet after entering their username and
password to authenticate. This example shows only two users, User1 is authenticated by a password stored on
the FortiGate unit, User2 is authenticated on an external authentication server. Both of these users are referred
to as local users because the user account is created on the FortiGate unit.

Creating a locally-authenticated user account

User1 is authenticated by a password stored on the FortiGate unit. It is very simple to create this type of account.
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To create a local user - web-based manager:

1. Go to User & Device > User Definition and select Create New.
2. Follow the User Creation Wizard, entering the following information and then select Create:

User Type Local User

User Name User1

Password hardtoguess

Email Address
SMS

(optional)

Enable Select.

To create a local user - CLI:

config user local
edit user1

set type password
set passwd hardtoguess

end

Creating a RADIUS-authenticated user account

To authenticate users using an external authentication server, you must first configure the FortiGate unit to
access the server.

To configure the remote authentication server - web-based manager:

1. Go to User & Device > RADIUS Servers and select Create New.
2. Enter the following information and select OK:

Name OurRADIUSsrv

Primary Server Name/IP 10.11.101.15

Primary Server Secret OurSecret

Authentication Scheme Select Use Default Authentication Scheme.

To configure the remote authentication server - CLI:

config user radius
edit OurRADIUSsrv

set server 10.11.102.15
set secret OurSecret
set auth-type auto

end

Creation of the user account is similar to the locally-authenticated account, except that you specify the RADIUS
authentication server instead of the user’s password.

564 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Examples and Troubleshooting

To configure a remote user - web-based manager:

1. Go to User & Device > User Definition and select Create New.
2. Follow the User Creation Wizard, entering the following information and then select Create:

User Type Remote RADIUSUser

User Name User2

RADIUS server OurRADIUSsrv

Email Address
SMS

(optional)

Enable Select

To configure a remote user - CLI:

config user local
edit User2

set name User2
set type radius
set radius-server OurRADIUSsrv

end

Creating user groups

There are two user groups: an FSSO user group for FSSO users and a firewall user group for other users. It is not
possible to combine these two types of users in the same user group.

Creating the FSSO user group

For this example, assume that FSSO has already been set up on the Windows network and that it uses Advanced
mode, meaning that it uses LDAP to access user group information. You need to

l configure LDAP access to the Windows AD global catalog
l specify the collector agent that sends user logon information to the FortiGate unit
l select Windows user groups to monitor
l select and add the Engineering and Sales groups to an FSSO user group

To configure LDAP for FSSO - web-based manager:

1. Go to User & Device > LDAP Servers and select Create New.
2. Enter the following information:

Name ADserver

Server Name / IP 10.11.101.160

Distinguished Name dc=office,dc=example,dc=com

Bind Type Regular
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User DN cn=FSSO_Admin,cn=users,dc=office,dc=example,dc=com

Password set_a_secure_password

3. Leave other fields at their default values.
4. Select OK.

To configure LDAP for FSSO - CLI"

config user ldap
edit "ADserver"

set server "10.11.101.160"
set dn "cn=users,dc=office,dc=example,dc=com"
set type regular
set username "cn=administrator,cn=users,dc=office,dc=example,dc=com"
set password set_a_secure_password

next
end

To specify the collector agent for FSSO - web-based manager

1. Go to User & Device > Single Sign-On and select Create New.
2. Enter the following information:

Type Fortinet Single Sign-On Agent

Name WinGroups

Primary Agent IP/Name 10.11.101.160

Password fortinet_canada

LDAP Server ADserver

3. Select Apply & Refresh.
In a few minutes, the FortiGate unit downloads the list of user groups from the server.

To specify the collector agent for FSSO - CLI:

config user fsso
edit "WinGroups"

set ldap-server "ADserver"
set password ENC

G7GQV7NEqilCM9jKmVmJJFVvhQ2+wtNEe9T0iYA5Sa+EqT2J8zhOrbkJFDr0RmY3c4LaoXdsoBczA
1dONmcGfthTxxwGsigzGpbJdC71spFlQYtj

set server "10.11.101.160"
end

To create the FSSO_Internet-users user group - web-based manager:

1. Go to User & Device > User Groups and select Create New.
2. Enter the following information and then select OK:
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Name FSSO_Internet_users

Type Fortinet Single Sign-On (FSSO)

Members Engineering, Sales

To create the FSSO_Internet-users user group - CLI:

config user group
edit FSSO_Internet_users

set group-type fsso-service
set member CN=Engineering,cn=users,dc=office,dc=example,dc=com

CN=Sales,cn=users,dc=office,dc=example,dc=com
end

Creating the Firewall user group

The non-FSSO users need a user group too. In this example, only two users are shown, but additional members
can be added easily.

To create the firewall user group - web-based manager:

1. Go to User & Device > User Groups and select Create New.
2. Enter the following information and then select OK:

Name Internet_users

Type Firewall

Members User1, User2

To create the firewall user group - CLI:

config user group
edit Internet_users

set group-type firewall
set member User1 User2

end

Defining policy addresses

1. Go to Policy & Objects > Addresses.
2. Create the following addresses:

Address Name Internal_net

Type Subnet

Subnet / IP Range 10.11.102.0/24

Interface Port 3
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Address Name Windows_net

Type Subnet

Subnet / IP Range 10.11.101.0/24

Interface Port 2

Creating security policies

Two security policies are needed: one for firewall group who connect through port3 and one for FSSO group who
connect through port2.

To create a security policy for FSSO authentication - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information:

Incoming Interface Port2

Source Address Windows_net

Source User(s) FSSO_Internet_users

Outgoing Interface Port1

Destination Address all

Schedule always

Service ALL

NAT ON

Security Profiles Optionally, enable security profiles.

3. Select OK.

To create a security policy for FSSO authentication - CLI:

config firewall policy
edit 0

set srcintf port2
set dstintf port1
set srcaddr Windows_net
set dstaddr all
set action accept
set groups FSSO_Internet_users
set schedule always
set service ALL
set nat enable

end
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To create a security policy for local user authentication - web-based manager

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information:

Incoming Interface Port3

Source Address Internal_net

Source User(s) Internet_users

Outgoing Interface Port1

Destination Address all

Schedule always

Service ALL

NAT ON

Security Profiles Optionally, enable security profiles.

3. Select OK.

To create a security policy for local user authentication - CLI

config firewall policy
edit 0

set srcintf port3
set dstintf port1
set srcaddr internal_net
set dstaddr all
set action accept
set schedule always
set groups Internet_users
set service ALL
set nat enable

end

LDAP Dial-in using member-attribute example
In this example, users defined in MicroSoft Windows Active Directory (AD) are allowed to set up a VPN
connection simply based on an attribute that is set to TRUE, instead of based on their user group. In AD the
"Allow Dialin" property is activated in the user properties, and this sets the msNPAllowDialin attribute to
"TRUE".

This same procedure can be used for other member attributes, as your system requires.

To accomplish this with a FortiGate unit, member-attribute must be set. This can only be accomplished through
the CLI - the option is not available through the web-based manager.

Before configuring the FortiGate unit, ensure the AD server has the msNPAllowDialin attribute set to "TRUE"
for the users in question. If not, those users will not be able to authenticate.
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To configure user LDAP member-attribute settings - CLI:

config user ldap
edit "ldap_server"

set server "192.168.201.3"
set cnid "sAMAccountName"
set dn "DC=fortilabanz,DC=com,DC=au"
set type regular
set username "fortigate@sample.com"
set password ******
set member-attr "msNPAllowDialin"

next
end

To configure LDAP group settings - CLI:

config user group
edit "ldap_grp"

set member "ldap"
config match

edit 1
set server-name "ldap"
set group-name "TRUE"

next
end

next
end

Once these settings are in place, users that are a member of the ldap user group will be able to authenticate.

To ensure your settings are correct, here is the sample output from a diag debug command that shows the
authentication process.

When the "Allow Dial-in" attribute is set to "TRUE" the following will likely be in the output:

get_member_of_groups-Get the memberOf groups.
get_member_of_groups- attr='msNPAllowDialin', found 1 values
get_member_of_groups-val[0]='TRUE'
fnbamd_ldap_get_result-Auth accepted
fnbamd_ldap_get_result-Going to DONE state res=0
fnbamd_auth_poll_ldap-Result for ldap svr 192.168.201.3 is SUCCESS
fnbamd_auth_poll_ldap-Passed group matching

If the attribute is not set but it is expected, the following will likely be in the output:

get_member_of_groups-Get the memberOf groups.
get_member_of_groups- attr='msNPAllowDialin', found 1 values
get_member_of_groups-val[0]='FALSE'
fnbamd_ldap_get_result-Auth accepted
fnbamd_ldap_get_result-Going to DONE state res=0
fnbamd_auth_poll_ldap-Result for ldap svr 192.168.201.3 is SUCCESS
fnbamd_auth_poll_ldap-Failed group matching

The only difference between these two outputs is the last line which is either passed or failed based on if the
member-attribute is set to the expected value or not.
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RADIUS SSO example
A common RADIUS SSO topology involves a medium sized company network of users connecting to the Internet
through the FortiGate unit, and authenticating with a RADIUS server. RADIUS SSO authentication was selected
because it is fast and relatively easy to configure.

This section includes:

l Assumptions
l Topology
l Configuring RADIUS
l Configuring FortiGate regular and RADIUS SSO security policies
l Testing

Assumptions

l VDOMs are not enabled
l The admin super_admin administrator account will be used for all FortiGate unit configuration.
l Any other devices on the network do not affect the topology of this example, and therefore are not included.
l Anywhere settings are not described, they are assumed to be default values.
l ARADIUS server is installed on a server or FortiAuthenticator unit and uses default attributes.
l BGP is used for any dynamic routing.
l Authentication event logging under Log&Report has been configured.

Topology

Example.com has an office with 20 users on the internal network. These users need access to the Internet to do
their jobs. The office network is protected by a FortiGate-60C unit with access to the Internet through the wan1
interface, the user network on the internal interface, and all the servers are on the DMZ interface. This includes
an Ubuntu Linux server running FreeRADIUS. For this example only two users will be configured — Pat Lee with
an account name plee, or plee@example.com, and Kelly Green with an account name kgreen, or
kgreen@example.com.

RADIUS SSO topology
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Configuring RADIUS

Configuring RADIUS includes configuring the RADIUS server such as FreeRADIUS, a radius client on user’s
computers, and configuring users in the system. For this example the two users will be Pat Lee, and Kelly Green.
They belong to a group called exampledotcom_employees. When it is all configured, the RADIUS daemon
needs to started.

The users have a RADIUS client installed on their PCs that allows them to authenticate through the RADIUS
server.

FreeRADIUS can be found on the freeradius.org website. For any problems installing FreeRADIUS, see the
FreeRADIUS documentation.

Configuring FortiGate interfaces

Before configuring the RADIUS SSO security policy, configure FortiGate interfaces. This includes defining a
DHCP server for the internal network as this type of network typically uses DHCP. The wan1 and dmz interfaces
are assigned static IP addresses and do not need a DHCP server.

FortiGate interfaces used in this example

Interface Subnet Act as DHCP Server Devices

wan1 172.20.120.141 No Internet Service Provider

dmz 10.11.101.100 No Servers, including RADIUS
server

internal 10.11.102.100 Yes: x.x.x.110-.250 Internal user network

To configure FortiGate interfaces - web-based manager:

1. Go to Network > Interfaces.
2. Select wan1 to edit.
3. Enter the following information and select OK.

Alias Internet

Addressing Mode Manual

IP/Network Mask 172.20.120.141/255.255.255.0

Administrative Access HTTPS, SSH

Enable DHCP Server Not selected

Comments Internet

Administrative Status Up

4. Select dmz to edit.
5. Enter the following information and select OK.
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Alias Servers

Addressing Mode Manual

IP/Network Mask 10.11.101.100/255.255.255.0

Administrative Access HTTPS, SSH, PING, SNMP

Enable DHCP Server Not selected

Listen for RADIUS
Accounting Messages

Select

Comments Servers

Administrative Status Up

6. Select internal to edit.
7. Enter the following information and select OK.

Alias Internal network

Addressing Mode Manual

IP/Network Mask 10.11.102.100/255.255.255.0

Administrative Access HTTPS, SSH, PING

Enable DHCP Server Select

Address Range 10.11.102.110 - 10.11.102.250

Netmask 255.255.255.0

Default Gateway Same as Interface IP

DNS Server Same as System DNS

Comments Internal network

Administrative Status Up

Configuring a RADIUS SSO Agent on the FortiGate unit

To create a RADIUS SSO agent:

1. Go to User & Device > Single Sign-On and select Create New.
2. In Type, select RADIUS Single-Sign-On Agent.
3. Select Use RADIUS Shared Secret and enter the RADIUS server shared secret.
4. Select Send RADIUS Responses.
5. Select OK.

The Single Sign-On agent is named RSSO_Agent.
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Creating a RADIUS SSO user group

To define a local user group for RADIUS SSO:

1. Go to User & Device > User Groups and select Create New.
2. Enter a Name for the user group.
3. In Type, select RADIUS Single Sign-On (RSSO).
4. In RADIUS Attribute Value, enter the name of the RADIUS user group this local user group represents.
5. Select OK.

Configuring FortiGate regular and RADIUS SSO security policies

With the RADIUS server and FortiGate interfaces configured, security policies can be configured. This includes
both RADIUS SSO and regular policies, as well as addresses and address groups. All policies require NAT to be
enabled.

Security policies required for RADIUS SSO

Seq.
No. From -> To Type Schedule Description

1 internal ->
wan1

RADIUS SSO business hours Authenticate outgoing user traffic.

2 internal ->
wan1 regular always Allow essential network services and

VoIP.

3 dmz -> wan1 regular always Allow servers to access Internet.

4 internal ->
dmz regular always Allow users to access servers.

5 any -> any deny always Implicit policy denying all traffic that
hasn’t been matched.

The RADIUS SSO policy must be placed at the top of the policy list so it is matched
first. The only exception to this is if you have a policy to deny access to a list of banned
users. In this case, that policy must go at the top so the RADIUS SSO does not
mistakenly match a banned user or IP address.

This section includes:

l Schedules, address groups, and services groups
l Configuring regular security policies
l Configuring RADIUS SSO security policy

Schedules, address groups, and services groups

This section lists the lists that need to be configured before security policies are created. Creating these lists is
straight forward, so the essential information has been provided here but not step by step instructions. For more
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information on firewall related details, see

Schedules

Only one schedule needs to be configured — business_hours. This is a fairly standard Monday to Friday 8am
to 5pm schedule, or whatever days and hours covers standard work hours at the company.

Address groups

The following address groups need to be configured before the security policies.

Address Group Name Interface Address range included

internal_network internal 10.11.102.110 to 10.11.102.250

company_servers dmz 10.11.101.110 to 10.11.101.250

Service groups

The following service groups need to be configured before the security policies. Note that the services listed are
suggestions and may include more or less as required.

Service Group Name Interface Description of services to be included

essential_network_services internal Any network protocols required for normal
network operation such as DNS, NTP,
BGP.

essential_server_services dmz

All the protocols required by the company
servers such as BGP, HTTP, HTTPS,
FTP, IMAP, POP3, SMTP, IKE, SQL,
MYSQL, NTP, TRACEROUTE, SOCKs,
and SNMP.

user_services internal Any protocols required by users HTTP,
HTTP, FTP,

The following security policy configurations are basic and only include logging, and default AV and IPS.

Configuring regular security policies

Regular security policies allow or deny access for non-RADIUS SSO traffic. This is essential as there are network
services—such as DNS, NTP, and FortiGuard—that require access to the Internet.

To configure regular security policies - web-based manager:

1. Go to Policy & Objects > IPv4 Policy, and select Create New.
2. Enter the following information, and select OK.

Incoming Interface Internal
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Source Address internal_network

Outgoing Interface wan1

Destination Address all

Schedule always

Service essential_network_services

Action ACCEPT

NAT ON

Security Profiles ON: AntiVirus, IPS

Log Allowed Traffic ON

Comments Essential network services

3. Select Create New, enter the following information, and select OK.

Incoming Interface dmz

Source Address company_servers

Outgoing Interface wan1

Destination Address all

Schedule always

Service essential_server_services

Action ACCEPT

NAT ON

Security Profiles ON: AntiVirus, IPS

Log Allowed Traffic enable

Comments Company servers accessing the Internet

4. Select Create New, enter the following information, and select OK.

Incoming Interface Internal

Source Address internal_network

Outgoing Interface dmz

Destination Address company_servers
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Schedule always

Service all

Action ACCEPT

NAT ON

Security Profiles ON: AntiVirus, IPS

Log Allowed Traffic enable

Comments Access company servers

Configuring RADIUS SSO security policy

The RADIUS SSO policy allows access for members of specific RADIUS groups.

To configure RADIUS SSO security policy:

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Enter the following information:

Incoming Interface Internal

Source Address internal_network

Source User(s) Select the user groups you created for RSSO.

Outgoing Interface wan1

Destination Address all

Schedule business_hours

Service ALL

Action ACCEPT

NAT ON

Security Profiles ON: AntiVirus, WebFilter, IPS, and Email Filter. In each case, select the
default profile.

4. Select OK.
5. To ensure an RSSO-related policy is matched first, the policy should be placed higher in the security policy list

than more general policies for the same interfaces.
6. Select OK.
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Testing

Once configured, a user only needs to log on to their PC using their RADIUS account. After that when they
attempt to access an Internet website, the FortiGate unit will use their session information to get their RADIUS
information. Once the user is verified, they are allowed access to the website.

To test the configuration perform the following steps:

1. Have user 'plee' logon to their PC, and try to access an Internet website.
2. The FortiGate unit will contact the RADUS server for user plee’s information.

Once confirmed, plee will have access to the website.
Each step generates log entries that enable you to verify that each step was successful.

3. If a step is unsuccessful, confirm that your configuration is correct.

RADIUS SSO test

Troubleshooting
In the web-based manager, a good tool for troubleshooting is the packet counter column on the security policy
page at Policy & Objects > IPv4 Policy. This column displays the number of packets that have passed
through this security policy. Its value when you are troubleshooting is that when you are testing your configuration
(end to end connectivity, user authentication, policy use) watching the packet count for an increase confirms any
other methods you may be using for troubleshooting. It provides the key of which policy is allowing the traffic,
useful information if you expect a user to require authentication and it never happens.

This section addresses how to get more information from the CLI about users and user authentication attempts
to help troubleshoot failed authentication attempts.

diag firewall iprope list

Shows the IP that the computer connected from. This is useful to confirm authorization and VPN settings.

diag firewall iprope clear

Clear all authorized users from the current list. Useful to force users to re-authenticate after system or
group changes. However, this command may easily result in many users having to re-authenticate, so use
carefully.
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diag rsso query ip
diag rsso query rsso-key

Queries the RSSO database.
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Chapter 4 - Best Practices

Best practices

This FortiGate Best Practices document is a collection of guidelines to ensure the most secure and reliable
operation of FortiGate units in a customer environment. It is updated periodically as new issues are identified.

General Considerations
1. For security purposes, NAT mode is preferred because all of the internal or DMZ networks can have secure private

addresses. NAT mode policies use network address translation to hide the addresses in a more secure zone from
users in a less secure zone.

2. Use virtual domains (VDOMs) to group related interfaces or VLAN subinterfaces. Using VDOMs will partition
networks and create added security by limiting the scope of threats.

3. Use Transparent mode when a network is complex and does not allow for changes in the IP addressing scheme.

Customer service and technical support
For antivirus and attack definition updates, firmware updates, updated product documentation, technical support
information, and other resources, please visit the Fortinet Technical Support web site at
http://support.fortinet.com.

You can also register Fortinet products and service contracts from http://support.fortinet.com and change your
registration information at any time.

For information about our priority support hotline (live support), see http://support.fortinet.com.

When requesting technical support, please provide the following information:

l Your name, and your company’s name and location
l Your email address and/or telephone number
l Your support contract number (if applicable)
l The product name and model number
l The product serial number (if applicable)
l The software or firmware version number
l A detailed description of the problem

Fortinet Knowledge Base
The most recent Fortinet technical documentation is available from the Fortinet Knowledge Base. The knowledge
base contains short how-to articles, FAQs, technical notes, product and feature guides, and much more. Visit the
Fortinet Knowledge Base at http://kb.fortinet.com.
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Comments on Fortinet technical documentation

Please send information about any errors or omissions in this document, or any Fortinet technical documentation,
to techdoc@fortinet.com.
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System and performance

By implementing the following best practices for system and performance, you will ensure maximum efficiency of
your FortiGate device. Be sure to read everything carefully, particularly the section that concerns shutting down
the FortiGate system, in order to avoid potential hardware issues.

Performance
l Disable any management features you do not need. If you don’t need SSH or SNMP, disable them. SSH also

provides another possibility for would-be hackers to infiltrate your FortiGate unit.
l Put the most used firewall rules to the top of the interface list.
l Log only necessary traffic. The writing of logs, especially if to an internal hard disk, slows down performance.
l Enable only the required application inspections.
l Keep alert systems to a minimum. If you send logs to a syslog server, you may not need SNMP or email alerts,

making for redundant processing.
l Establish scheduled FortiGuard updates at a reasonable rate. Daily updates occurring every 4-5 hours are sufficient

for most situations. In more heavy-traffic situations, schedule updates for the evening when more bandwidth can be
available.

l Keep security profiles to a minimum. If you do not need a profile on a firewall rule, do not include it.
l Keep VDOMs to a minimum. On low-end FortiGate units, avoid using them if possible.
l Avoid traffic shaping if you need maximum performance. Traffic shaping, by definition, slows down traffic.

Shutting down
Always shut down the FortiGate operating system properly before turning off the power switch to avoid potentially
catastrophic hardware problems.

To power off the FortiGate unit - web-based manager:

1. Go to Dashboard.
2. In the System Resourceswidget, select Shutdown.

To power off the FortiGate unit – CLI:

execute shutdown

Once this has been done, you can safely turn off the power switch or disconnect the power cables from the power
supply.
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Migration

Network administrators are often reluctant to change firewall vendors due to the perception that the migration
process is difficult. Indeed, there is no point hiding the fact that moving to a new vendor requires careful
consideration. But concern over the potential pain of migration should not stand in the way of adopting new
security technologies. The purpose of this chapter is to describe the best practices for performing such migrations
and ultimately to ease the migration process itself.

Information gathering
It is always best practice to perform a full network audit prior to any migration. This should include:

l Full back up of all security systems (including switches, routers) in case a back-out needs to be performed.
l Physical and logical network diagram with visual audit

Understanding exactly where cables run in the network and verifying they are all correctly labeled is essential to
avoid mistakes and unnecessary downtime during the upgrade. Don’t overlook simple things such as:

l Do I have enough spare interfaces on my switches?
l Do I have the right fiber (single/multi mode) and right connectors (LC, FC, MTRJ, SC, ST)?
l Do I have spare cables? (in the heat of the moment, it is a simple mistake to break an RJ-45 connector or damage a

fiber)
l Do I have space in the rack for the new equipment?
l Do I have enough power sockets?

No matter how securely a FortiGate is configured in the network, it cannot help if it has been bypassed; visually
checking where the device sits in the network in relation to other devices will ensure you are maintaining security
and verify the network diagram is ‘as built’. Details of all networks including subnet masks should be documented
at this point to ensure that the replacement device is configured with the correct information.

Object and policy migration
Whilst we have suggested some level of manual review is included in the policy migration, it can be useful to be
able to automatically migrate simply between another vendor’s format and the FortiGate format. The FortiGate
policy format is text based and can easily be cut and pasted into from other vendor formats however, responding
to the high customer demand to migrate away from other vendors, Fortinet have released an automatic
configuration migration tool at http://convert.fortinet.com to simplify this process. Supporting Cisco ACLs, PIX,
ASA, Check Point, and Juniper, the Converter can securely upload and convert the policy into the Fortinet format.

Testing and validation
This is an important process and should be tested offline first wherever possible i.e. configure the policy in the lab
or on a test network and verify that the required access permissions are being implemented. To really test the
solution out, the FortiGate can be implemented on the live network with a different gateway IP and the selected
user pointed to the new gateway. This allows a staged approach to migrating the new platform into the network
ensuring that the process does not interrupt day to day operations.
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Going live and obtaining feedback
If testing and validation is successful at this point, you can migrate to the new firewall either by switching IP's and
removing the old devices or by changing the default gateway in DHCP. Once the firewall is in place, acceptance
testing will of course need to be carried out and an iterative process of tuning undertaken to finalize the
configuration.

Adding new services
The Fortinet solution will have a plethora of additional features compared to your previous vendor and it is very
tempting to start switching them on but it is a good idea to wait and validate the new firewall as was previously
configured before adding new functions as this simplifies testing and problem diagnosis. Finally complete the
migration (don’t forget about the Plan Do Check Act Cycle) by adding any new services that were requested and
learn about the multiple features you have available with the FortiGate appliance.
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Environmental specifications

Keep the following environmental specifications in mind when installing and setting up your FortiGate unit.

l Operating temperature: 32 to 104°F (0 to 40°C). Temperatures may vary, depending on the FortiGate model.
l If you install the FortiGate unit in a closed or multi-unit rack assembly, the operating ambient temperature of the

rack environment may be greater than room ambient temperature.
Therefore, make sure to install the equipment in an environment compatible with the manufacturer's maximum
rated ambient temperature.

l Storage temperature: -13 to 158°F (-25 to 70°C). Temperatures may vary, depending on the FortiGate model.
l Humidity: 5 to 90% non-condensing.
l Air flow - For rack installation, make sure that the amount of air flow required for safe operation of the equipment is

not compromised.
l For free-standing installation, make sure that the appliance has at least 1.5 in. (3.75 cm) of clearance on each side

to allow for adequate air flow and cooling.

Depending on your device, the FortiGate may generate, use, and even radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If the equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:

l Reorient or relocate the receiving antenna.
l Increase the separation between the equipment and receiver.
l Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
l Consult the dealer or an experienced radio/TV technician for help.

Explosion is a serious risk if the battery is replaced by an incorrect type. Dispose of
used batteries according to the instructions. To reduce the risk of fire, use only No. 26
AWG or larger UL Listed or CSACertified Telecommunication Line Cord.

Grounding
l Ensure the FortiGate unit is connected and properly grounded to a lightning and surge protector. WAN or LAN

connections that enter the premises from outside the building should be connected to an Ethernet CAT5 (10/100
Mb/s) surge protector.

l Shielded Twisted Pair (STP) Ethernet cables should be used whenever possible rather than Unshielded Twisted
Pair (UTP).

l Do not connect or disconnect cables during lightning activity to avoid damage to the FortiGate unit or personal
injury.

Rack mounting
l Elevated Operating Ambient - If installed in a closed or multi-unit rack assembly, the operating ambient

temperature of the rack environment may be greater than room ambient.
Therefore, consideration should be given to installing the equipment in an environment compatible with the
maximum ambient temperature (Tmax) specified by the manufacturer.
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l Reduced Air Flow - Installation of the equipment in a rack should be such that the amount of air flow required for
safe operation of the equipment is not compromised.

l Mechanical Loading - Mounting of the equipment in the rack should be such that a hazardous condition is not
achieved due to uneven mechanical loading.

l Circuit Overloading - Consideration should be given to the connection of the equipment to the supply circuit and
the effect that overloading of the circuits might have on overcurrent protection and supply wiring. Appropriate
consideration of equipment nameplate ratings should be used when addressing this concern.

l Reliable Earthing - Reliable earthing of rack-mounted equipment should be maintained.

Particular attention should be given to supply connections other than direct connections to the branch circuit (e.g.
use of power strips).
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Firmware

Firmware upgrading and downgrading sounds pretty simple, anyone can do it, right? The mark of a professional
is not that they can do something correctly, or even do it correctly over and over again. A professional works in
such a way that, if anything goes wrong they are prepared and able to quickly get things back to normal. Firmware
updates can go wrong just like anything else. So a real professional does things in a way that minimizes their risk
and follows some best practices, as listed below.

Firmware change management
Consider the following five points when performing firmware upgrades, not only in FortiOS but in general. This
applies to pretty much any change you have to do in a production environment.

Understanding the new version first

Before attempting any changes in production, first make sure you set up a laboratory where you can freely play
with the new features, and understand them with enough time and no pressure. Read the Release Notes,
Manuals, and other documentation like presentations, videos, or podcasts about the new version.

You are ready to explain the need for an upgrade once you understand:

l The differences and the enhancements between the new version and the previous version(s).
l The impact of the upgrade on customers and the users of the operating platform.
l The known limitations that might affect your environment.
l The potential risks when performing the upgrade.
l The licensing changes that may apply.

Never attempt to upgrade to a version you don't fully understand (both on features and
known limitations), and on which you have no operational experience.

Have a valid reason to upgrade

The reason can NOT be “Because I want to have the latest version”. The reason has to be explained in terms of
business, technical, and/or operational improvement.

Affirmative answers to the following questions are valid reasons to upgrade:

l Does the new version have a feature that helps to ensure compliance?
l Does the new version have an enhancement that allows 40% decrease (40% improvement) on the time to perform

a certain operation?
l Does the new feature correct a known defect/bug found on a previous version that affects the company

business/operations?
l Will the new version allow your organization to deploy new services that will help to gain new customers or increase

loyalty of existing ones?
l Is the vendor cutting support for the version your organization is currently using?
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If the best reason to upgrade is “Because the new features seem to be cool” or “Because I want to have the latest
version”, a little more understanding and planning may be necessary.

Prepare an upgrade plan

If you choose to upgrade because you found a valid reason to do so, make sure you create a plan that covers
business, technical, and operational aspects of the upgrade:

Business:

Proper planning and justification for an upgrade should be proportional to how critical the system is to the
business.

l Make sure you can clearly articulate the benefits of the upgrade in business terms (time, money, and efficiency).
l Understand the business processes that will be affected by the change.
l Make sure the upgrade maintenance window is not close to a business-critical process (such as quarterly or monthly

business closure).
l Obtain executive and operational approval for the maintenance window. The approval must come from the owners

of ALL the systems/information affected by the upgrade, not only from those that own the system being upgraded.
The approval must be done in a formal (written or e-mail) form.

Technical and operational:

l Re-read the Release Notes for the technology you are upgrading. Supported hardware models, upgrade paths, and
known limitations should be clearly understood.

l Make sure your upgrade maintenance window does not overlap with any other maintenance window on your
infrastructure.

l If you have any premium support offer (such as TAM, Premium Support), do a capacity planning exercise to ensure
the new firmware/software version does not take more hardware resources than you currently have.

l Create a backup, whether or not you have scheduled backups. Create a new fresh backup.
l Obtain offline copies of both the currently installed firmware and the new version.
l Create a list of systems with inter-dependencies to the system you are upgrading. For example, if you are

upgrading a FortiGate; understand the impact on any FortiAP, FortiAuthenticator, FortiToken, FortiManager, or
FortiAnalyzer you have on your environment.

l Ensure you have a list of adjacent devices to the upgrading platform and have administrative access to them, just in
case you need to do some troubleshooting. Are you upgrading FortiWeb? Make sure you can administratively
access the Web Applications. Are you upgrading a FortiGate? Make sure you can administratively access the
surrounding switches and routers.

l Have a step-by-step plan on how to perform and test the upgrade. You want to make sure you think of the worst
situation before it happens, and have predefined courses of action, instead of thinking under pressure when
something already went wrong.

l Define a set of tests (that include critical business applications that should be working) to make sure the upgrade
went fine. If any test does not go well, define which ones mandate a rollback and which ones can be tolerated for
further troubleshooting. This set of tests should be run before and after the upgrade to compare results, and they
should be the same.

l Define a clear rollback plan. If something goes wrong with the upgrade or the tests, the rollback plan will help you
get your environment back to a known and operational status. The plan must clearly state the conditions under
which the rollback will be started.

588 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 4 - Best Practices Firmware

l Declare configuration freezes. A little bit before and after the upgrade. The idea is to reduce the amount of
variables to take into consideration if something goes wrong.

l Perform a “Quality Assurance” upgrade. Grab a copy of the production configuration, load it on a non-production
box and execute the upgrade there to see if there are any issues on the process. Then adjust your plan according to
the results you obtained.

l Have a list of information elements to be gathered if something goes wrong. This ensures that, even if the upgrade
fails, you will collect enough information so you can troubleshoot the issue without needing to repeat the problem.
Get help from TAC/Support departments if you need to check what else could be missing on your list.

l Define a test monitoring period after the change was completed. Even if the upgrade went smoothly, something
could still go wrong. Make sure you monitor the upgraded system for at least one business cycle. Business cycles
may be a week, a month, or a quarter, depending on your organization’s business priorities.

Execute the upgrade plan

Execution of an upgrade is just as key as planning.

Once you are performing the upgrade, the pressure will rise and stress might peak. This is why you should stick to
the plan you created with a cool head.

Resist the temptation to take decisions while performing the upgrade, as your judgment will be clouded by the
stress of the moment, even if a new decision seems to be “obvious” at such time. If your plan says you should
rollback, then execute the rollback despite the potential “We-can-fix-this-very-quickly” mentality.

While performing the upgrade, make sure all the involved components are permanently monitored before, during,
and after the upgrade, either via monitoring systems, SNMP alerts, or at least with tools like a ping. Critical
resources like CPU, memory, network, and/or disk utilization must also be constantly monitored.

To avoid misunderstandings, when performing the tests for each critical application defined on the planning,
make sure there are formal notifications on the results for each user area, service, system, and/or application
tested.

Regardless if you have to rollback or not, if a problem occurs, make sure you gather as much information about
the problem as possible, so you can later place a support ticket to find a solution.

Last but not least, document the upgrade:

l Enable your terminal emulation program to leave trace of all the commands executed and all the output generated.
If you are performing steps via GUI, consider using a video capture tool to document it.

l Document any command or change performed over the adjacent/interdependent systems. Make sure they are
acknowledged by the relevant administrators

l Document any deviations performed over the upgrade plan. This is planned-versus-actual.

Learn more about change management

Change Management and Change Control are huge knowledge areas in the field of Information Systems and
Computer/Network Security.

This document is by no means a comprehensive list on what you should do when performing an upgrade, with
either Fortinet or any other technology. It is merely a list of important things you should take into consideration
when performing upgrades which are the result of years of experience dealing with changes on critical
environments, as it is common that security devices are protecting critical applications and processes.
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There are vast resources on the topic: books, public white papers, blog entries, etc. If you search the Internet for
the “Change Control Best Practices” or “Change Management Best Practices” you will get many interesting
documents.

Changes on production IT infrastructure are critical to the business. Make sure they
play in your favor and not against you.

Performing a firmware upgrade
Upgrading a firewall is something that should be compared to upgrading the operating system on your computer.
It’s not to be taken lightly! You want to make sure everything is backed up and you have some options available if
things go awry. Assuming it all seems to work you also want a list of things to do in order to confirm everything is
working properly. Finally, you need enough time to do it. All really simple stuff, but what does this mean in
relation to upgrading your FortiGate? It means, you follow these simple steps:

1. Backup and store old configuration (full configuration backup from CLI).
Digging into this a little, step 1 is easy to understand. Do a full backup of your old configuration. This is all part of
your disaster recovery plan. If the upgrade fails in some way you need to make sure you can get the Firewall back
up and running. The best way to do this is to get it back to a state where you know what the behavior was. For
more information, refer to "Performing a configuration backup" on page 591.

2. Have copy of old firmware available.
Step 2, is also part of your disaster recovery. If the upgrade fails you might be able to switch the active partition.
But as a Professional, you need to be prepared for the worst case scenario where you can’t do that. Which means
you’ll need your old firmware.

3. Have disaster recovery option on standby -- especially if remote.
Step 3, is your plan for what to do in the event of a critical failure. As we’re talking FortiGate this means that your
firewall doesn’t come back after the upgrade. What this means is that you need to be able to get to the console
port in order to find out why. Maybe it’s DHCP and the IP changed, maybe the OS is corrupt, who knows? Get to
the console and find out.
There could be a simple fix. If there’s not, then be prepared for a format and TFTP reload.

4. Read the release notes, including the upgrade path and bug information.
Step 4, READ THERELEASENOTES. They contain all kinds of information, known bugs, fixed bugs even
upgrade issues like lost configuration settings. Not all upgrade information is ever contained in any products
release notes. That does not mean they are devoid of good/useful information. Read them, digest them, then a
few days later read them again.

5. Double check everything.
Step 5, do a double check of everything. Is your TFTP server working, does your console connection function, is
there anything in the release notes that could impact your upgrade procedure, do you have your configuration
backed up? Make sure you’ve done everything.

6. Upgrade.
Step 6, do the upgrade. Doing an upgrade doesn’t take very long, a few minutes (less a lot of times) but make sure
you schedule enough time for it. At the end of the day an upgrade can succeed or fail. If it succeeds you want
some time to check/confirm that any important features you have are working (VPNs etc). If it fails you’ll need time
to sort things out.

590 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 4 - Best Practices Firmware

Performing a firmware downgrade
Just like upgrading, you need to make sure it’s done properly. While similar, the steps are somewhat different
since there are other pitfalls in this case.

1. Locate pre-upgrade configuration file.
Step 1 is very important. This is why, when you upgrade you make a backup of your old configuration and save it.
If you don’t, then you’ll need to rebuild manually.

2. Have copy of old firmware available.
Step 2 is fairly obvious. Even with devices that have multiple partitions and your downgrade process is simply
going to be to switch the active partition, this could go wrong. In which case, you may be without Internet access.
A professional has a plan for when things go wrong.

3. Have disaster recovery option on standby -- especially if remote.
Step 3 is no different from before. Hopefully you don’t need to format the unit, but be prepared for that, just in
case.

4. Read the release notes -- is a downgrade possible, or necessary?
Step 4, once again, is to READ THERELEASENOTES. In this case, you will need to do this for the version you
are on, and the version you are downgrading too, and everything in between (if you are going back multiple major
releases or patches). Maybe the OS switched from 32 to 64 bits somewhere between the two firmware releases.
In order to make sure you don’t get nailed by something like that you need to check the upgrade and downgrade
information in every major release and patch, as it may have a direct impact on your options.

5. Double check everything.
6. Downgrade -- all settings, except those needed for access, are lost.

Step 5 and 6 are the same as before. Double check everything, then downgrade.
7. Restore pre-upgrade configuration.

Step 7 is new. Obviously most settings are lost when you downgrade so in order to get back up and running you
will need to restore your old configuration file.

Performing a configuration backup
Once you configure the FortiGate unit and it is working correctly, it is extremely important that you backup the
configuration. In some cases, you may need to reset the FortiGate unit to factory defaults or perform a TFTP
upload of the firmware, which will erase the existing configuration. In these instances, the configuration on the
device will have to be recreated, unless a backup can be used to restore it.

It is also recommended that once any further changes are made that you backup the configuration immediately,
to ensure you have the most current configuration available. Also, ensure you backup the configuration before
upgrading the FortiGate unit’s firmware. Should anything happen during the upgrade that changes the
configuration, you can easily restore the saved configuration.

Always backup the configuration and store it on the management computer or off-site. You have the option to
save the configuration file to various locations including the local PC, USB key, FTP and TFTP site.The latter two
are configurable through the CLI only.

If you have VDOMs, you can back up the configuration of the entire FortiGate unit or only a specific VDOM. Note
that if you are using FortiManager or FortiCloud, full backups are performed and the option to backup individual
VDOMs will not appear.
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To back up the FortiGate configuration - web-based manager:

1. Go to Dashboard.
2. On the System Information widget, select Backup next to System Configuration.
3. Select to backup to your Local PC or to a USB Disk.

The USB Disk option will be grayed out if no USB drive is inserted in the USB port. You can also backup to the
FortiManager using the CLI.

4. If VDOMs are enabled, select to backup the entire FortiGate configuration (Full Config) or only a specific VDOM
configuration (VDOM Config).

5. If backing up a VDOM configuration, select the VDOM name from the list.
6. Select Encrypt configuration file.

Encryption must be enabled on the backup file to back up VPN certificates.
7. Enter a password and enter it again to confirm it. You will need this password to restore the file.
8. Select Backup.
9. The web browser will prompt you for a location to save the configuration file. The configuration file will have a

.conf extension.

To back up the FortiGate configuration - CLI:

execute backup config management-station <comment>

… or…

execute backup config usb <backup_filename> [<backup_password>]

… or for FTP (note that port number, username are optional depending on the FTP site)…

execute backup config ftp <backup_filename> <ftp_server> [<port>] [<user_name>]
[<password>]

… or for TFTP…

execute backup config tftp <backup_filename> <tftp_servers> <password>

Use the same commands to backup a VDOM configuration by first entering the commands:

config vdom
edit <vdom_name>

Backing up a configuration file using SCP

You can use secure copy protocol (SCP) to download the configuration file from the FortiGate unit as an
alternative method of backing up the configuration file or an individual VDOM configuration file. This is done by
enabling SCP for and administrator account and enabling SSH on a port used by the SCP client application to
connect to the FortiGate unit. SCP is enabled using the CLI commands:

config system global
set admin-scp enable

end

Use the same commands to backup a VDOM configuration by first entering the commands:

config global
set admin-scp enable

end
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config vdom
edit <vdom_name>
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Security Profiles (AV, Web Filtering etc.)

Infection can come from many sources and have many different effects. Because of this, there is no single means
to effectively protect your network. Instead, you can best protect your network with the various UTM tools your
FortiGate unit offers.

Firewall
l Be careful when disabling or deleting firewall settings. Changes that you make to the firewall configuration using

the GUI or CLI are saved and activated immediately.
l Arrange firewall policies in the policy list from more specific to more general. The firewall searches for a matching

policy starting from the top of the policy list and working down. For example, a very general policy matches all
connection attempts. When you create exceptions to a general policy, you must add them to the policy list above
the general policy.

l Avoid using the All selection for the source and destination addresses. Use addresses or address groups.
l If you remove all policies from the firewall, there are no policy matches and all connections are dropped.
l If possible, avoid port ranges on services for security reasons.
l The settings for a firewall policy should be as specific as possible. Do not use 0.0.0.0 as an address. Do not use Any

as a service. Use subnets or specific IP addresses for source and destination addresses and use individual services
or service groups.

l Use a 32-bit subnet mask when creating a single host address (for example, 255.255.255.255).
l Use logging on a policy only when necessary and be aware of the performance impact. For example, you may want

to log all dropped connections but can choose to use this sparingly by sampling traffic data rather than have it
continually storing log information you may not use.

l It is possible to use security policies based on 'any' interface. However, for better granularity and stricter security,
explicit interfaces are recommended.

l Use the comment field to input management data, for example: who requested the rule, who authorized it, etc.
l Avoid FQDN addresses if possible, unless they are internal. It can cause a performance impact on DNS queries and

security impact from DNS spoofing.
l For non vlan interfaces, use zones (even if you have only one single interface for members) to allow:

l An explicit name of the interface to use in security policies ('internal' is more explicit than 'port10').
l A split between the physical port and its function to allow port remapping (for instance moving from a 1G

interface to a 10G interface) or to facilitate configuration translation, as performed during hardware upgrades.

Security
l Use NTP to synchronize time on the FortiGate and the core network systems, such as email servers, web servers,

and logging services.
l Enable log rules to match corporate policy. For example, log administration authentication events and access to

systems from untrusted interfaces.
l Minimize adhoc changes to live systems, if possible, to minimize interruptions to the network. When not possible,

create backup configurations and implement sound audit systems using FortiAnalyzer and FortiManager.
l If you only need to allow access to a system on a specific port, limit the access by creating the strictest rule

possible.
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Authentication
l You must add a valid user group to activate the Authentication check box on the firewall policy configuration page.
l Users can authenticate with the firewall using HTTP or FTP. For users to be able to authenticate, you must add an

HTTP or FTP policy that is configured for authentication.

Antivirus
l Enable antivirus scanning at the network edge for all services.
l Use FortiClient endpoint antivirus scanning for protection against threats that get into your network.
l Subscribe to FortiGuard AntiVirus Updates and configure your FortiGate unit to receive push updates. This will

ensure you receive antivirus signature updates as soon as they are available.
l To ensure that all AV push updates occur, ensure you have an AV profile enabled in a security policy.
l Enable only the protocols you need to scan. If you have antivirus scans occurring on the SMTP server, or use

FortiMail, it is redundant to have scanning occur on the FortiGate unit as well.
l Reduce the maximum file size to be scanned. Viruses usually travel in small files of around 1 to 2 megabytes.
l Do not quarantine files unless you regularly monitor and review them. This is otherwise a waste of space and

impacts performance.
l Examine antivirus reports and log messages periodically. Take particular notice of repeated detections. For

example, repeated virus detection in SMTP traffic could indicate a system on your network is infected and is
attempting to contact other systems to spread the infection using a mass mailer.

Antispam
l If possible use, a FortiMail unit. The antispam engines are more robust.
l Use fast DNS servers.
l Use specific security profiles for the rule that will use antispam.
l DNS checks may cause false positive with HELO DNS lookup.
l Content analysis (banned words) may impose performance overhead.

Intrusion Prevention System (IPS)
Your FortiGate’s IPS system can detect traffic attempting to exploit this vulnerability. IPSmay also detect when
infected systems communicate with servers to receive instructions. Refer to the following list of best practices
regarding IPS.

l Enable IPS scanning at the network edge for all services.
l Use FortiClient endpoint IPS scanning for protection against threats that get into your network.
l Subscribe to FortiGuard IPS Updates and configure your FortiGate unit to receive push updates. This will ensure

you receive IPS signature updates as soon as they are available.
l Because it is critical to guard against attacks on services that you make available to the public, configure IPS

signatures to block matching signatures. For example, if you have a web server, configure the action of web server
signatures to Block.

l Create and use security profiles with specific signatures and anomalies you need per-interface and per-rule.
l Do not use predefined or generic profiles. While these profiles are convenient to supply immediate protection, you

should create profiles to suit your network environment.
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l If you do use the default profiles, reduce the IPS signatures/anomalies enabled in the profile to conserve processing
time and memory.

l If you are going to enable anomalies, make sure you tune thresholds according to your environment.
l If you need protection, but not audit information, disable the logging option.
l Tune the IP-protocol parameter accordingly.

Blocking Skype using CLI options for improved detection

If you want to identify or block Skype sessions, use the following CLI command with your FortiGate's public
IP address to improve detection (FortiOS 4.3.12+ and 5.0.2+):

config ips global
set skype-client-public-ipaddr 198.51.100.0,203.0.113.0

end

Note that the above syntax is configured using multiple public IP addresses, where a single public IP address may
suffice depending on your network configuration.

Email filter
Spam is a common means by which attacks are delivered. Users often open email attachments they should not,
and infect their own machine.

l Enable email filtering at the network edge for all types of email traffic.
l Use FortiClient endpoint IPS scanning for protection against threats that get into your network.
l Subscribe to the FortiGuard AntiSpam Service.

amURL filtering
Best practices for URL filtering can be divided into four categories: flow-based versus proxy based filtering; local
category/rating feature; URL filter ‘Exempt’ action; and Deep Scan.

Flow-based versus proxy-based

Try to avoid mixing flow-based and proxy-based features in the same profile if you are not using IPS or
Application Control.

Local category/rating feature

Local categories and local rating features consume a large amount of CPU resources, so use these features as
little as possible. It is better to use Local categories instead of using the ‘override’ feature, since the ‘override’
feature is more complicated and more difficult to troubleshoot.

URL filter ‘Exempt’ action

When using the URL filter ‘Exempt’ option,webfilter, antivirus and dlp scans are bypassed by default, so use this
option only for trusted sites.

Configuration notes: You need to configure ‘Exempt’ actions in the URL filter if you want to bypass the
FortiGuard Web Filter.You can configure which particular inspection(s) you want to bypass using the set
exempt command in config webfilter urlfilter.

596 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 4 - Best Practices Security Profiles (AV, Web Filtering etc.)

Deep Scan

The ‘Deep Scan’ feature is much heavier on resources than ‘HTTPSURL Scan Only’. Deep Scan is much more
accurate, since many sites (such as various Google applications) cannot be scanned separately without deep
scanning enabled.

Note: If you configure Deep Scan in the SSL profile and then configure ‘Enable HTTPSURL Scan Only’ in the
web filter profile, then Deep Scan is not performed.

Web filtering
FortiGuard Web Filtering can help stop infections from malware sites and help prevent communication if an
infection occurs.

l Enable FortiGuard Web Filtering at the network edge.
l Install the FortiClient application and use FortiGuard Web Filtering on any systems that bypass your FortiGate unit.
l Block categories such as Pornography, Malware, Spyware, and Phishing. These categories are more likely to be

dangerous

Patch management
When vulnerabilities are discovered in software, the software vendors release updates that fix these problems.
Keeping your software and operating system up-to-date is a vital step to prevent infection and defend against
attacks.

l Follow the latest advisories and reports on the FortiGuard webpage.
l Apply updates to all software as the updates become available.
l FortiGuard Vulnerability Management can help identify security weaknesses in your network. This subscription

service is available through FortiScan and FortiAnalyzer units.
l Apply firmware updates to your FortiGate unit as they are released.
l Subscribe to FortiGuard AntiVirus and IPS services, so that AntiVirus and IPS scanning engines are automatically

updated when new version are released.

Policy configuration
Configuring the FortiGate unit with an ‘allow all’ traffic policy is very undesirable. While this does greatly simplify
the configuration, it is less secure. As a security measure, it is best practice for the policy rulebase to ‘deny’ by
default, and not the other way around.

Policy configuration changes

On a heavy-loaded system, plan configuration changes during low usage periods in order to minimize impact on
CPU usage and established sessions. In this scenario, it is considered a best practice to de-accelerate the
hardware-accelerated sessions.

You can configure de-accelerated behaviour on hardware-accelerated sessions using CLI commands to control
how the processor manages policy configuration changes. The following CLI commands are to be used:

config system settings
set firewall-session-dirty { check-all | check-new | check-policy-option }

end
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where you want the following to be true:

check-all CPU flushes all current sessions and re-evaluates them. This is the default
option.

check-new CPU keeps existing sessions and applies policy changes to new sessions
only. This reduces CPU load and the possibility of packet loss.

check-policy-option Use the option selected in the firewall-session-dirty field of the
firewall policy (check-all or check-new, as above, but per policy).

Policy whitelisting

l Allow only the necessary inbound and outbound traffic.
l If possible, limit traffic to specific addresses or subnets. This allows the FortiGate unit to drop traffic to and from

unexpected addresses.

IPS and DoS policies

l Because it is critical to guard against attacks on services that you make available to the public, configure IPS
signatures to block matching signatures. For example, if you have a web server, configure the action of web server
signatures to Block.

l Your FortiGate unit includes IPS signatures written to protect specific software titles from DoS attacks. Enable the
signatures for the software you have installed and set the signature action to Block.

l DoS attacks are launched against vulnerabilities. Maintain a FortiGuard IPS subscription to ensure your FortiGate
unit automatically receives new and updated IPS signatures as they are released.

l Use and configure DoS policies to appropriate levels based on your network traffic and topology. This will help drop
traffic if an abnormal amount is received. The key is to set a good threshold. The threshold defines the maximum
number of sessions/packets per second of normal traffic. If the threshold is exceeded, the action is triggered.
Threshold defaults are general recommendations, but your network may require very different values. One way to
find the correct values for your environment is to set the action to Pass and enable logging. Observe the logs and
adjust the threshold values until you can determine the value at which normal traffic begins to generate attack
reports. Set the threshold above this value with the margin you want. Note that the smaller the margin, the more
protected your system will be from DoS attacks, but your system will also be more likely to generate false alarms.
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Networking

When configuring your network, ensure that there is no ‘back door’ access to the protected network. For example,
if there is a wireless access point, it must be appropriately protected with password and encryption.

Be sure to also maintain an up-to-date network diagram which includes IP addressing, cabling, and network
elements.

Routing configuration
l Always configure a default route.
l Add blackhole routes for subnets reachable using VPN tunnels. This ensures that if a VPN tunnel goes down, traffic

is not mistakingly routed to the Internet unencrypted.

Policy routing

Keep the number of policy routes to a minimum to optimize performance in route lookup and to simplify
troubleshooting.

Dynamic routing

l Select a Router ID that matches an IP assigned to an interface. This avoids the likelihood of having two devices
with the same router ID.

l For routing over an IPsec tunnel, assign IP addresses to both ends of the tunnel.

Advanced routing
Use the following best practices for advanced routing when dealing with Border Gateway Protocol (BGP) and
Open Shortest Path First (OSPF).

Border Gateway Protocol (BGP)

If you are using BGP, it is recommended that you enable soft-reconfiguration. This has two benefits:

l It allows you to perform ‘soft clear’ of peers after a change is made to a BGP policy.
l It provides greater visibility into the specific prefixes learned from each neighbor.

Leave soft-reconfiguration disabled if your FortiGate does not have much unused memory. Soft-reconfiguration
requires keeping separate copies of prefixes received and advertised, in addition to the local BGP database.

Open Shortest Path First (OSPF)

l Avoid use of passive interfaces wherever possible.
l Avoid use of virtual links to connect areas. All areas should be designed to connect directly to the backbone area.
l Ensure that all backbone routers have a minimum of two peering connections to other backbone neighbors.
l An entire OSPF domain should be under common administration.
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Network Address Translation (NAT)
l Beware of misconfiguring the IP Pool range. Double-check the start and end IPs of each IP pool. The IP pool should

not overlap with addresses assigned to FortiGate interfaces or to any hosts on directly connected networks.
l If you have internal and external users accessing the same servers, use split DNS to offer an internal IP to internal

users so that they don’t have to use the external-facing VIP.

Configuring NAT

Do not enable NAT for inbound traffic unless it is required by an application. If, for example, NAT is enabled for
inbound SMTP traffic, the SMTP server might act as an open relay.

Transparent Mode
l Do not connect two ports to the same VLAN on a switch or to the same hub. Some Layer 2 switches become

unstable when they detect the same MAC address originating on more than one switch interface or from more than
one VLAN.

l If you operate multiple VLANs on your FortiGate unit, assign each VLAN id to its own forwarding domain to ensure
that the scope of the broadcast does not extend beyond the VLAN it originated in.

To protect against Layer 2 loops:

l Enable stpforward on all interfaces.
l Use separate VDOMs for production traffic (TPmode VDOM) and management traffic (NAT mode VDOM).
l Only place those interfaces used for production in the TPmode VDOM. Place all other interfaces in the NAT mode

VDOM. This protects against potential Layer 2 loops.

Using Virtual IPs (VIPs)
l Use the external IP of 0.0.0.0 when creating a VIP for a FortiGate unit where the external interface IP address is

dynamically assigned.
l Be sure to select the correct external interface when creating a new virtual IP (VIP). The external interface should be

set to the interface at which the FortiGate unit receives connection requests from external networks.
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FGCP High Availability

Fortinet suggests the following practices related to high availability:

l Use Active-Active HA to distribute TCP and UTM sessions among multiple cluster units. An active-active cluster
may have higher throughput than a standalone FortiGate unit or than an active-passive cluster.

l Use a different host name on each FortiGate unit when configuring an HA cluster. Fewer steps are required to add
host names to each cluster unit before configuring HA and forming a cluster.

l Consider adding an Alias to the interfaces used for the HA heartbeat so that you always get a reminder about what
these interfaces are being used for.

l Enabling load-balance-all can increase device and network load since more traffic is load-balanced. This
may be appropriate for use in a deployment using the firewall capabilities of the FortiGate unit and IPS but no other
content inspection.

l An advantage of using session pickup is that non-content inspection sessions will be picked up by the new primary
unit after a failover. The disadvantage is that the cluster generates more heartbeat traffic to support session pickup
as a larger portion of the session table must be synchronized. Session pickup should be configured only when
required and is not recommended for use with SOHO FortiGate models. Session pickup should only be used if the
primary heartbeat link is dedicated (otherwise the additional HA heartbeat traffic could affect network performance).

l If session pickup is not selected, after a device or link failover all sessions are briefly interrupted and must be re-
established at the application level after the cluster renegotiates. For example, after a failover, users browsing the
web can just refresh their browsers to resume browsing. Users downloading large files may have to restart their
download after a failover. Other protocols may experience data loss and some protocols may require sessions to be
manually restarted. For example, a user downloading files with FTPmay have to either restart downloads or restart
their FTP client.

l If you need to enable session pickup, consider enabling session-pickup-delay to improve performance by
reducing the number of sessions that are synchronized. See Improving session synchronization performance on
page 1954.

l Consider using the session-sync-dev option to move session synchronization traffic off the HA heartbeat link
to one or more dedicated session synchronization interfaces.See Improving session synchronization performance
on page 1954.

l To avoid unpredictable results, when you connect a switch to multiple redundant or aggregate interfaces in an
active-passive cluster you should configure separate redundant or aggregate interfaces on the switch; one for each
cluster unit.

l Use SNMP, syslog, or email alerts to monitor a cluster for failover messages. Alert messages about cluster failovers
may help find and diagnose network problems quickly and efficiently.

Heartbeat interfaces
Fortinet suggests the following practices related to heartbeat interfaces:

Do not use a FortiGate switch port for the HA heartbeat traffic. This configuration is
not supported.
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l Configure at least two heartbeat interfaces and set these interfaces to have different priorities.
l For clusters of two FortiGate units, as much as possible, heartbeat interfaces should be directly connected using

patch cables (without involving other network equipment such as switches). If switches have to be used they should
not be used for other network traffic that could flood the switches and cause heartbeat delays.
l If you cannot use a dedicated switch, the use of a dedicated VLAN can help limit the broadcast domain to

protect the heartbeat traffic and the bandwidth it creates.
l For clusters of three or four FortiGate units, use switches to connect heartbeat interfaces. The corresponding

heartbeat interface of each FortiGate unit in the cluster must be connected to the same switch. For improved
redundancy use a different switch for each heartbeat interface. In that way if the switch connecting one of the
heartbeat interfaces fails or is unplugged, heartbeat traffic can continue on the other heartbeat interfaces and
switch.

l Isolate heartbeat interfaces from user networks. Heartbeat packets contain sensitive cluster configuration
information and can consume a considerable amount of network bandwidth. If the cluster consists of two FortiGate
units, connect the heartbeat interfaces directly using a crossover cable or a regular Ethernet cable. For clusters with
more than two units, connect heartbeat interfaces to a separate switch that is not connected to any network.

l If heartbeat traffic cannot be isolated from user networks, enable heartbeat message encryption and authentication
to protect cluster information. See Enabling or disabling HA heartbeat encryption and authentication on page 1917.

l Configure and connect redundant heartbeat interfaces so that if one heartbeat interface fails or becomes
disconnected, HA heartbeat traffic can continue to be transmitted using the backup heartbeat interface. If heartbeat
communication fails, all cluster members will think they are the primary unit resulting in multiple devices on the
network with the same IP addresses and MAC addresses (condition referred to asSplit Brain) and communication
will be disrupted until heartbeat communication can be reestablished.

l Do not monitor dedicated heartbeat interfaces; monitor those interfaces whose failure should trigger a device
failover.

l Where possible at least one heartbeat interface should not be connected to an NP4 or NP6 processor to avoid NP4
or NP6-related problems from affecting heartbeat traffic.

l Where possible, the heartbeat interfaces should not be connected to an NP4 or NP6 processor that is also
processing network traffic.

l Where possible, each heartbeat interface should be connected to a different NP4 or NP6 processor.
l Any FortiGate interface can be used as a heartbeat interface including 10/100/1000Base-T, SFP, QSFP fiber and

copper, and so on. If you set up two or more interfaces as heartbeat interfaces each interface can be a different
type and speed.

Interface monitoring (port monitoring)
Fortinet suggests the following practices related to interface monitoring (also called port monitoring):

l Wait until a cluster is up and running and all interfaces are connected before enabling interface monitoring. A
monitored interface can easily become disconnected during initial setup and cause failovers to occur before the
cluster is fully configured and tested.

l Monitor interfaces connected to networks that process high priority traffic so that the cluster maintains connections
to these networks if a failure occurs.

l Avoid configuring interface monitoring for all interfaces.
l Supplement interface monitoring with remote link failover. Configure remote link failover to maintain packet flow if

a link not directly connected to a cluster unit (for example, between a switch connected to a cluster interface and the
network) fails. See Remote link failover (remote IPmonitoring) on page 1943.
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WAN Optimization

WANOptimization features require significant memory resources and generate a high amount of I/O on disk.
Before enabling WAN Optimization, ensure that the memory usage is not too high. If possible, avoid other disk-
intensive features such as heavy traffic logging on the same disk as the one configured for WAN Optimization
needs.

In general, it is preferable to enable the Transparent Mode checkbox and ensure that routing between the two
endpoints is acceptable. Some protocols may not work well without enabling Transparent Mode.

Other best practices for utilizing the WAN Optimization feature follow.

Sharing the WAN Opt. tunnel for traffic of the same nature

WAN optimization tunnel sharing is recommended for similar types of WAN optimization traffic (such as CIFS
traffic from different servers). However, tunnel sharing for different types of traffic is not recommended. For
example, aggressive and non-aggressive protocols should not share the same tunnel.

Ordering WAN Opt. rules appropriately

l Precise, port specific WAN Optimization rules should be at the top of the list.
l Generic rules, such as overall TCP, should be at the bottom of the list.

Avoiding mixing protocols in a WAN Opt. tunnel

Different protocols may be more or less talkative or interactive . Mixing protocols in a tunnel may result in a delay
for some of them. It is recommended to define protocol specific wan-optimization rules and restrict the ports to
the necessary ones only for performance reasons.

Setting correct configuration options for CIFS WAN Opt.

Ensure that the WAN Optimization rules cover TCP ports 139 and 445 (on the same or two different rules). Also
ensure that Transparent Mode is selected.

Setting correct configuration options for MAPI WAN Opt.

For MAPI WAN Optimization, only specify a rule with TCP port 135 (unless the MAPI control port is configured
differently). Derived data sessions using other random ports will be handled by the CIFS wan-optimization
daemon even with only the control port configured.

Testing WAN Opt. in a lab

l Ensure that WAN emulators are used to simulate the WAN. If no WAN emulator is used, it is expected to have
better results without WAN Optimization than with WAN Optimization.

l To test the difference between cold transfers (first-time transfers) and warm transfers, it is recommended to
generate a random file of the cold transfer to ensure that the test is the first time that the file has been seen.
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Regarding byte compression and type of file

Enabling byte compression on file transfers already compressed (.jpeg files, compressed archive, etc.) won't
provide any performance increase and could be seen as a misuse of CPU resources.

Regarding network address translation (NAT)

Selecting the NAT feature in a security policy does not have any influence on WAN Optimization traffic.

High Availability

There is no benefit to using active-active mode, so for pure WAN Optimization needs, use active-passive mode.
Refer to the FGCPHigh Availability section for other best practices related to HA.

Authentication with specific peers

Configure WAN optimization authentication with specific peers. Accepting any peer is not recommended as this
can be less secure.
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Virtual Domains (VDOMs)

VDOMs can provide separate firewall policies and, in NAT mode, completely separate configurations for routing
and VPN services for each connected network or organization. This section provides a list of best practices for
configuring VDOMs.

Per-VDOM resource settings
While Global resources apply to resources shared by the whole FortiGate unit, per-VDOM resources are specific
to only one Virtual Domain.

By default all the per-VDOM resource settings are set to no limits. This means that any single VDOM can use up
all the resources of the entire FortiGate unit if it needs to do so. This would starve the other VDOMs for resources
to the point where they would be unable to function. For this reason, it is recommended that you set some
maximums on resources that are most vital to your customers.

Virtual domains in NAT mode
Once you have enabled virtual domains and created one or more VDOMs, you need to configure them. It is
recommended that you perform the following tasks in the order given (while you may not require all for your
network topology):

1. Change the management virtual domain.
2. Configure FortiGate interfaces in a NAT VDOM.
3. Configure VDOM routing.
4. Configure security policies for NAT VDOMs.
5. Configure UTM profiles for NAT VDOMs.
6. Test the configuration.

Virtual clustering
If you decide to disable override for clurstering, as a result of persistent renegotiating, you should disable it for
both cluster units.
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Explicit proxy

l For explicit proxies, when configuring limits on the number of concurrent users, you need to allow for the number of
users based on their authentication method. Otherwise you may run out of user resources prematurely.

l Each session-based authenticated user is counted as a single user using their authentication membership
(RADIUS, LDAP, FSSO, local database etc.) to match users in other sessions. So one authenticated user in
multiple sessions is still one user.

l For all other situations, the source IP address is used to determine a user. All sessions from a single source address
are assumed to be from the same user.

l Set the explicit web proxy and explicit FTP proxy Default Firewall Policy Action to Deny. This means that a firewall
policy is required to use these explicit proxies, allowing you to control access and impose security features.

l Do not enable the explicit web or FTP proxy on an interface connected to the Internet. This is a security risk
because anyone on the Internet who finds the proxy could use it to hide their source address. If you must enable the
proxy on such an interface make sure authentication is required to use the proxy.
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Wireless

The following section contains a list of best practices for wireless network configurations with regard to encryption
and authentication, geographic location, network planning, power usage, client load balancing, local bridging,
SSIDs, and the use of static IPs.

Encryption and authentication
It is best practice to always enable the strongest user authentication and encryption method that your client
supports. Fortinet recommends the following security, in order of strongest to weakest:

l WPA2 - Enterprise 802.1x/EAP - Personal pre-shared key (8-63 characters)
l WPA - Enterprise 802.1x/EAP - Personal pre-shared key (8-63 characters)
l WEP128 - 26 Hexadecimal digit key
l WEP64 - 10 Hexadecimal digit key
l None - Open system

Geographic location
Ensure that the FortiGate wireless controller is configured for your geographic location. This ensures that the
available radio channels and radio power are in compliance with the regulations in your region.

The maximum allowed transmitter power and permitted radio channels for Wi-Fi networks depend on the region
in which the network is located. By default, the WiFi controller is configured for the United States. If you are
located in any other region, you need to set your location before you begin configuring wireless networks.

The location setting can only be changed from CLI. To change the country to France, for example, enter the
following:

config wireless-controller setting
set country FR

end

To see the list of country codes, enter a question mark (‘?’) in place of the country code.

Using an incorrect geographic location is a common error that can lead to unpredicable results on the client side.

Network planning
It is recommended that you perform a proper site survey prior positioning the wireless access point. In order to
evaluate the coverage area environment, the following criteria must be taken into account:

l Size of coverage area
l Bandwidth required
l Client wireless capabilities

After completing a RF site survey, you’ll have a good idea of the number and location of access points needed to
provide users with adequate coverage and performance.

However, prior to installing the access points, be sure to determine the RF channel(s) you plan to use. This will
ensure that users can roam throughout the facility with substantial performance.
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To avoid co-channel interference, adjacent Wi-Fi APs must be configured to use non-overlapping channels.
Otherwise, you’ll find poor performance will degrade because of interference between access points.

It is recommended to statically configure the non-overlapping channels on every access point, using one Custom
AP profile per AP (or group of APs). If static configuration cannot be used, the FortiOSWi-Fi Controller includes
the Automatic Radio Resource Provisioning (ARRP) feature.

Lowering the power level to reduce RF interference
Relevant Product(s): FortiAP

Reducing power reduces unwanted coverage and potential interference to other WLANs. Areas of unwanted
coverage are a potential security risk. If possible, reduce the transmitter power of your wireless access point so
that the signal is not available beyond the areas where it is needed. Auto Tx Power Control can be enabled to
automatically adjust the transmit power.

In cases where customers complain about slow wireless traffic through a FortiAP, it might be necessary to try to
reduce the possibility of RF interference. It is best practice not to locate FortiAPs near steel beams or other
interfering materials. You can try using a wireless sniffer tool to collect the wireless packets and then analyze the
extent of air interference.

A common mistake is spacing FortiAPs based upon the 5Ghz radio frequency. The 2.4Ghz signal travels further.

You have two options when confronted with slow wireless traffic through a FortiAP:

Option #1: Reducing transmit power

Perform a speed test and record the results. Set one of the radios on a FortiAP to be in dedicated monitoring
mode. Then observe how many APs are detected. If the number of APs is too high (i.e., greater than 20), try
reducing the transmit power in the WTP profile for the FortiAPs until the number of dedicated APs has dropped
significantly.

Repeat the speed test.

Option #2: Ensuring that VAPs are distributed over the available channels

No built-in tools are available to measure RF interference directly. However, FortiOS 5.0 does allow for automatic
power adjustment, which should minimize the occurrence of RF interference.

Wireless client load balancing
Wireless load balancing allows your wireless network to more efficiently distribute wireless traffic among wireless
access points and available frequency bands. FortiGate wireless controllers support the following types of client
load balancing:

l Access Point Hand-off - The wireless controller signals a client to switch to another access point.
l Frequency Hand-off - The wireless controller monitors the usage of 2.4GHz and 5GHz bands, and signals clients

to switch to the lesser-used frequency.

Local bridging
Whenever possible, use local bridging to offload the CAPWAP tunnel. Note that in this case, Wi-Fi client devices
obtain IP addresses from the same DHCP server as wired devices on the LAN. The vlan ID can only be configured
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from the CLI:

config wireless-controller vap
edit "vaplocalbridge"

set vdom "root"
set ssid "testvaplocalbridge"
set local-bridging enable
set vlanid 40 ---> only available in CLI

next
end

Advertising SSIDs
l It is highly recommended to advertise the SSID. It makes it easier for customers and wireless clients. Also, if you

'hide' the SSID (known as ‘network cloaking’), then clients will always look for it when they're outside the coverage
area, which searches for known SSIDs, in effect leaking the SSID anyway. Refer to RFC 3370. Furthermore, many
of the latest Broadcom drivers do not support hidden SSID for WPA2.

l For security reason, you might want to prevent direct communication between your wireless clients. In this case,
enable Block Intra-SSID Traffic (in the SSID configuration).

l In a network with multiple wireless controllers, you need to change the mesh SSID so that each mesh root has a
unique SSID. Other controllers using the same mesh root SSID might be detected as fake or rogue APs. Go toWiFi
& Switch Controller > SSID to change the SSID. Fortinet also recommends that you create a new preshared key
instead of using the default.

Using static IPs in a CAPWAP configuration
In a large FortiAP deployment with more than 20 FortiAPs connecting to a Fortigate Wireless Controller (AC), it is
recommended to use static IPs on the access points instead of DHCP, setting the AC IP statically and the AC
discovery type to static (Type 1), instead of learning it through broadcast, multicast, or DHCP.

This makes management of the APs easier since you know the exact IP of each access point. Troubleshooting
also becomes easier as the debug of the AC controller won’t continuously attempt the different discovery
methods in sequence (broadcast > multicast > static).
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Logging and reporting

The default log device settings must be modified so that system performance is not compromised. The FortiGate
unit, by default, has all logging of FortiGate features enabled, except for traffic logging. The default logging
location will be either the FortiGate unit’s system memory or hard disk, depending on the model. Units with a
flash disk are not recommended for disk logging.

Log management
When the FortiGate unit records FortiGate activity, valuable information is collected that provides insight into
how to better protect network traffic against attacks, including misuse and abuse. There is a lot to consider before
enabling logging on a FortiGate unit, such as what FortiGate activities to enable and which log device is best
suited for your network’s logging needs. A plan can help you in deciding the FortiGate activities to log, a log
device, as well as a backup solution in the event the log device fails.

This plan should provide you with an outline, similar to the following:

l What FortiGate activities you want and/or need logged (for example, security features).
l The logging device best suited for your network structure.
l If you want or require archiving of log files.
l Ensuring logs are not lost in the event a failure occurs.

After the plan is implemented, you need to manage the logs and be prepared to expand on your log setup when
the current logging requirements are outgrown. Good log management practices help you with these tasks.

Log management practices help you to improve and manage logging requirements. Logging is an ever-expanding
tool that can seem to be a daunting task to manage. The following management practices will help you when
issues arise, or your logging setup needs to be expanded.

l Revisit your plan on a yearly basis to verify that your logging needs are being met by your current log setup. For
example, your company or organization may require archival logging, but not at the beginning of your network’s
lifespan. Archival logs are stored on a FortiGate unit’s local hard drive, a FortiAnalyzer unit, or a FortiCloud server,
in increasing order of size.

l Configure an alert message that will notify you of activities that are important to be aware about. For example: if a
branch office does not have a FortiGate administrator, you will need to know at all times that the IPsec VPN tunnel
is still up and running. An alert email notification message can be configured to send only if IPsec tunnel errors
occur.

l If your organization or company uses peer-to-peer programs such as Skype or other instant messaging software,
use the IM usage dashboard widget or the Executive Summary’s report widget (Top 10 Application Bandwidth
Usage Per Hour Summary) to help you monitor the usage of these types of instant messaging software. These
widgets can help you in determining how these applications are being used, including if there is any misuse and
abuse. Their information is taken from application log messages; however, application log messages should be
viewed as well since they contain the most detailed information.

l Ensure that your backup solution is up-to-date. If you have recently expanded your log setup, you should also review
your backup solution. The backup solution provides a way to ensure that all logs are not lost in the event that the log
device fails or issues arise with the log device itself.
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l When downloading log messages and viewing them on a computer, the log file will be downloaded like any other
file. Log file names contain their log type and date in the name, so it is recommended to create a folder in which to
archive your log messages, as they can be sorted easily.

Systemmemory and hard disks
If the FortiGate unit has a hard disk, it is enabled by default to store logs. This also means that you do not have to
enable this and configure the settings for logging to the hard disk, but modify these settings so that it is
configured for your network logging requirements.

If the FortiGate unit has only flash memory, disk logging is disabled by default, as it is not recommended.
Constant rewrites to flash drives can reduce the lifetime and efficiency of the memory. It must be enabled in the
CLI under config log disk setting.

For some low-end models, disk logging is unavailable. Check a product’s Feature Matrix for more information. In
either case, Fortinet recommends using either a FortiAnalyzer unit or the FortiCloud service.
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Chapter 5 - FortiGate-6000

What's new for FortiGate-6000 5.6.7

The following new features have been added to FortiGate-6000 and v5.6.7 build 4214:

l Policy learning mode is now supported.
l The FortiGate-6000 supports 64000 explicit proxy web proxy users.
l The HA group ID range is now from 0 to 31 (was 0 to 15).
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The following new features have been added to FortiGate-6000 v5.6.6 build 4148:

l Support for FortiOS 5.6.6 and most 5.6.6 features including FortiOS 5.6.6 GUI features.
l You can configure new Resource Usage dashboard widgets to show CPU use, log rate, memory use, session

creation rate, and the number of active sessions for the management board and for individual FPCs.
l The Security Fabric dashboard widget shows high level status and configuration information for all of the FPCs.
l The Sensor Information dashboard widget displays temperature, power supply (PSU), and fan speed information

and allows you to drill down for more details, including information about individual temperature sensors, PSUs and
fans.

l DP3 firmware upgrade
l VRRP support
l The following FortiOS 5.6.6 features are not supported:

l SD-WAN
l Some IPsec VPN features
l Policy learning mode
l HA dedicated management interfaces

New IPsec VPN features
FortiOS 5.6.6 includes the following IPsec VPN improvements:

l Including a phase 2 selector is no longer mandatory.
l Dynamic routing (RIP, OSPF, BGP) is supported over IPsec VPN tunnels.

IPsec VPN features supported by FortiOS 5.6.6 for FortiGate-6000

FortiOS 5.6.6 for FortiGate-6000 supports the following IPsec VPN features.

l Interface-based IPsec VPN (also called route-based IPsec VPN).
l Static routes can point IPsec VPN interfaces.
l Dynamic routing (RIP, OSPF, BGP) over IPsec VPN tunnels.
l Remote networks with 16- to 32-bit netmasks.
l IPsec VPN tunnels must terminate on the primary FPM (the ELBCmaster).
l Site-to-Site IPsec VPN.
l Dialup IPsec VPN. The FortiGate-6000 can be the dialup server or client.
l IPv4 clear-text traffic (IPv4 over IPv4 or IPv4 over IPv6)

IPsec VPN features not supported by FortiOS 5.6.6 for FortiGate-6000

FortiOS 5.6.6 for FortiGate-6000 does not support the following IPsec VPN features.

l Policy-based IPsec VPN.
l Policy routes for VPN traffic.
l Remote networks with 0- to 15-bit netmasks.
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l IPv6 clear-text traffic (IPv6 over IPv4 or IPv6 over IPv6).
l Load-balancing IPsec VPN tunnels to multiple FPMs.
l IPsec SA synchronization between both FortiGate-6000s in an HA configuration.
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FortiGate-6000 overview

The FortiGate-6000 series is a collection of 3U 19-inch rackmount appliances that all include twenty-four 25GigE
SFP28 and four 100GigEQSFP28 data network interfaces, as well as NP6 and CP9 processors to deliver high
IPS/threat prevention performance.

Currently, four FortiGate-6000 models are available:

l FortiGate-6500F
l FortiGate-6501F
l FortiGate-6300F
l FortiGate-6301F

All FortiGate-6000 models have the same front and back panel configuration including the same network
interfaces. The differences are the processing capacity of the individual models. All FortiGate-6000 models
include internal Fortinet Processor Cards (FPCs) that contain NP6 and CP9 security processors. The FortiGate-
6000 uses session-aware load balancing to distribute sessions to the FPCs. The FortiGate-6500F includes ten
FPCs and the FortiGate-6300F includes six FPCs.

Also the FortiGate-6501F and 6301F models are the same as their related models with the addition of two
internal 1 TByte log disks.

FortiGate-6000 front panel (FortiGate-6500F shown)

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

615



FortiGate-6000 overview Chapter 5 - FortiGate-6000

Front panel interfaces
All FortiGate-6000 models have the following front panel interfaces:

l Twenty-four 1/10/25GigE SFP28 data network interfaces (1 to 24). The default speed of these interfaces is
10Gbps.

l Four 40/100GigEQSFP28 data network interfaces (25 to 28). The default speed of these interfaces is 40Gbps.
l Two front panel 1/10GigE SFP+ HA interfaces (HA1 and HA2) used for heartbeat, session sync, and management

communication between two and only two FortiGate-6000s in an HA cluster. The default speed of these interfaces
is 10Gbps. Operating them at 1Gbps is not recommended. A FortiGate-6000 cluster consists of two (and only two)
FortiGate-6000s of the same model. To set up HA, you can use a direct cable connection between the FortiGate-
6000s HA1 interfaces and a second direct cable connection between the HA2 interfaces. For more information
about FortiGate-6000 HA, see FortiGate-6000 high availability (FGCP) on page 651.

l Two 10/100/1000BASE-T out of band management Ethernet interfaces (MGMT1 and MGMT2).
l One front panel 1/10GigE SFP+ out of band management interface (MGMT3). You can use the 10Gbps MGMT3

interface for additional bandwidth management traffic that might be useful for high bandwidth activities such as
remote logging.

l One RJ-45 RS-232 serial console connection.
l One USB connector.

FortiGate-6000 schematic
The FortiGate-6000 has separate data and management planes. The data plane handles all traffic and security
processing functionality. The management plane handles management functions such as administrator logins,
configuration and session synchronization, SNMP and other monitoring, HA heartbeat communication, and
remote and (if supported) local disk logging. Separating these two planes means that resources used for traffic
and security processing are not compromised by management activities.
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FortiGate-6000 schematic

In the data plane, two DP3 load balancers use session-aware load balancing to distribute sessions from the front
panel interfaces (port1 to 28) to Fortinet Processor Cards (FPCs). The DP3 processors communicate with the
FPCs across the 3.2Tbps integrated switch fabric. Each FPC processes sessions load balanced to it. The FPCs
send outgoing sessions back to the integrated switch fabric and then out the network interfaces to their
destinations.

The NP6 processor in each FPC enhances network performance with fastpath acceleration that offloads
communication sessions from the FPC CPU. The NP6 processor can also handle some CPU intensive tasks, like
IPsec VPN encryption/decryption.

The CP9 processors in each FPC accelerate many common resource intensive security related processes such as
SSL VPN, Antivirus, Application Control, and IPS.

The management plane includes the management board, base backplane, management interfaces, and HA
heartbeat interfaces. Configuration and session synchronization between FPCs in a FortiGate-6000F occurs over
the base backplane. In an HA configuration, configuration and session synchronization between the FortiGate-
6000s in the cluster takes place over the HA1 and HA2 interfaces. Administrator logins, SNMPmonitoring,
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remote logging to one or more FortiAnalyzers or syslog servers, and other management functions use the
MGMT1, MGMT2, and MGMT3 interfaces. You can use the 10Gbps MGMT3 interface for additional bandwidth
that might be useful for high bandwidth activities such as remote logging.
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Once you have installed your FortiGate-6000 in a rack and connected it to power you should review the front and
back panel LEDs to verify that everything is operating normally. Wait until the FortiGate-6000 has completely
started up and synchronized before making configuration changes. You can use the diagnose sys ha
status command to confirm that the FortiGate-6000 is completely initialized. If the output from entering this
command hasn't changed after checking for a few minutes you can assume that the system has initialized. You
don't normally have to confirm that the system has initialized, but this diagnose command is available if needed.

You can connect to the MGMT1 Ethernet interface to log into the GUI or CLI. Connect to the GUI by browsing to
https://192.168.1.99. Connect to the CLI by using SSH to connect to 192.168.1.99. Log into the GUI or CLI using
the admin account with no password. You may have to enable SSH administrative access for the mgmt1 interface
before you can connect to the CLI.

You can also connect to the CLI using the front panel Console port using the console cable shipped with your
product. For the console connection, use the following settings: Baud Rate (bps) 9600, Data bits 8, Parity None,
Stop bits 1, and Flow Control None.

For security reasons you should add a password to the admin account before
connecting the FortiGate-6000 to your network.

Once you have logged into the GUI or CLI you can view and change the configuration of your FortiGate-6000 just
like any FortiGate. For example, you can configure firewall policies between any two interfaces. You can also
configure aggregates of the front panel interfaces.
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Example FortiGate-6301F System Resources widget

Interface groups and changing data interface speeds
Depending on the networks that you want to connect your FortiGate-6000 to, you may have to manually change
the data interface speeds. The port1 to port24 data interfaces are divided into the following groups:

l port1 - port4
l port5 - port8
l port9 - port12
l port13 - port16
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l port17 - port20
l port21 - port24

All of the interfaces in a group operate at the same speed. Changing the speed of an interface changes the
speeds of all of the interfaces in the same group. For example, if you change the speed of port18 from 10Gbps to
25Gbps the speeds of port17 to port20 are also changed to 25Gbps.

Another example, the default speed of the port1 to port24 interfaces is 10Gbps. If you want to install 25GigE
transceivers in port1 to port24 to convert these data interfaces to connect to 25Gbps networks, you must enter
the following from the CLI:

config system interface
edit port1

set speed 25000full
next
edit port5

set speed 25000full
next
edit port9

set speed 25000full
next
edit port13

set speed 25000full
next
edit port17

set speed 25000full
next
edit port21

set speed 25000full
end

Every time you change a data interface speed, when you enter the end command, the CLI confirms the range of
interfaces affected by the change. For example, if you change the speed of port5 the following message appears:

config system interface
edit port5

end
port5-port8 speed will be changed to 25000full due to hardware limit.
Do you want to continue? (y/n)

Configuring the management interfaces
The default FortiGate-6000 configuration includes a management VDOM named mgmt-vdom. The management
interfaces mgmt1, mgmt2, and mgmt3 are all in this VDOM. The ha1 and ha2 interfaces are also in this VDOM.
This mgmt-vdom cannot be removed or renamed and interfaces cannot be removed from it or added to it.
Fortinet recommends managing the FortiGate-6000 from the mgmt1, mgmt2, and mgmt3 out-of-band
management interfaces and not from a data interface.

You can change the IP address of the management interfaces and configure routing for the management VDOM
as required. For example, from the GUI, select themgmt-vdom then go to Network > Interfaces to configure
the mgmt1, mgmt2, or mgmt3 interfaces.

From the CLI:

config system interface
edit mgmt1

set ip <ip-address> <netmask>
...
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Using data interfaces for management traffic
Normally, all management traffic connects with the FortiGate-6000 through the MGMT1, MGMT2, and MGMT3
interfaces. The FortiGate-6000 does also support management traffic connections to the FortiGate-6000 data
interfaces (port1 to port28). To enable management connections to these interfaces you must configure the
VDOM that the data interfaces are included in to allow traffic forwarding to the management board. By default,
the root VDOM includes all of the data interfaces. To allow management communication between the root
VDOM and the management board, edit the root VDOM from the CLI and use the following command:

config vdom
edit root

config system settings
set motherboard-traffic-forwarding {icmp | admin}

end

The icmp option, enabled by default, allows you to log into the management board from one of the MGMT
interfaces and use the execute ping command to ping an address through one of the data interfaces. The
interface used depends on the routing configuration.

The admin option allows Telnet, SSH, HTTP, and HTTPS administrator connections from a management PC to
a data interface. You cannot configure data interfaces to accept management connections using non-standard
ports.

Currently, the admin setting is in development and not recommended.

FortiGate-6000 dashboard widgets
The FortiGate-6000 includes a number of custom dashboard widgets that provide extra or custom information for
FortiGate-6000 systems.

Security Fabric

The Security Fabric dashboard widget shows the components in your FortiGate-6000 system including the
management board and FPCs. You can hover over the components in the Security Fabric dashboard widget to
see details about each components host name, serial number, model, firmware version, and management IP
address.

Interface Bandwidth

You can add Interface Bandwidth dashboard widgets to view traffic in and out of any FortiGate-6000 interface.
You can add an Interface Bandwidth widget to the dashboard for:

l Any physical interface
l Any link aggregation (LAG) interface
l Any member of a LAG
l Any VLAN interface
l Any IPsec VPN tunnel interface
l Any redundant interface
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The displayed data includes all of the traffic processed by the interface, independent of how the traffic is load
balanced.

You can add individual Interface Bandwidth widgets for each interface that you want to monitor. After you have
added the widget you can choose to display traffic for the last hour, 24 hours or week. The data displayed on the
widget updates in real time.

From the CLI, for physical interfaces, you can use the diagnose hardware deviceinfo nic
<interface-name> command to view transmitted and received packets.

For LAG and VLAN interfaces you can display transmitted and received packets using the diagnose netlink
interface list <interface-name> command.

Resource Usage

You can create multiple Resource Usage dashboard widgets to show CPU use, log rate, memory use, session
creation rate, and the number of active sessions for the management board and for individual FPCs. After you
have added the widget you can choose to display data for times ranging between 1 minute to 24 hours.The data
displayed on the widget updates in real time.

Sensor Information

The Sensor Information dashboard widget displays temperature, power supply (PSU), and fan speed information
for the FortiGate-7000 hardware and allows you to drill down for more details, including information about
individual temperature sensors, PSUs and fans.

Changing the FortiGate-6301F and 6501F log disk and RAID configuration
The FortiGate-6301F and FortiGate-6501F both include two internal 1-TByte log disks. By default the disks are in
a RAID-1 configuration. In the RAID-1 configuration you can use the disks for disk logging only. You can use the
execute disk raid command to disable RAID and use one of the disks for disk logging and the other for
other purposes such as disk caching. You can also change the RAID level to RAID-0. Changing the
RAID configuration deletes all data from the disks and can disrupt disk logging so a best practice is set the RAID
configuration when initially setting up the FortiGate-6301F or 6501F.

From the CLI you can use the following command to show disk status:

execute disk list

Use the following command to disable RAID:

execute disk raid disable

RAID is disabled, the disks are separated and formatted.

Use the following command to change the RAID level to RAID-0:

execute disk raid rebuild-level 0

The disks are formatted for RAID-0.

Use the following command to rebuild the current RAID partition:

execute disk raid rebuild

The RAID is rebuilt at the current RAID level.

Use the following command to show RAID status. The following command output shows the disks configured for
RAID-1.
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execute disk raid status
RAID Level: Raid-1
RAID Status: OK
RAID Size: 1000GB

Disk 1: OK Used 953GB
Disk 2: OK Used 953GB

Managing individual FPCs
When you log into the GUI or CLI using the MGMT1 interface IP address you are actually connecting to the
FortiGate-6000F management board (called slot 0 or MBD on the CLI). This is normally how you would connect
to a FortiGate-6000F for administration.

In some cases you may want to connect to the individual Fortinet Processor Cards (FPCs) in your FortiGate-
6000F. For example, you may want to view the traffic being processed by a specific FPC. You can connect to the
GUI or CLI of individual FPCs in the chassis using the system management IP address with a special port
number.

For example, if the system management IP address is 192.168.1.99 you can connect to the GUI of the first FPC
using the system management IP address followed by the special port number: https://192.168.1.99:44301.

The special port number (in this case 44301) is a combination of the service port (for HTTPS the service port is
443) and the FPC slot number (in this example, 01). The following table lists the special ports to use to connect to
each FPC slot using common admin protocols. The FortiGate-6300F and 6301F have 7 slots (0 to 6) and the
FortiGate-6500 and 6501 have 11 slots (0 to 10).

FortiGate-6000 special administration port numbers

Slot Address HTTP
(80) HTTPS (443) Telnet

(23) SSH (22)

Chassis 1, Slot 0, (MBD) 8000 44300 2300 2200

Chassis 1, Slot 1 (FPC01) 8001 44301 2301 2201

Chassis 1, Slot 2 (FPC02) 8002 44302 2302 2202

Chassis 1, Slot 3 (FPC03) 8003 44303 2303 2203

Chassis 1, Slot 4 (FPC04) 8004 44304 2304 2204

Chassis 1, Slot 5 (FPC05) 8005 44305 2305 2205

Chassis 1, Slot 6 (FPC06) 8006 44306 2306 2206

Chassis 1, Slot 7 (FPC07) 8007 44307 2307 2207

Chassis 1, Slot 8 (FPC08) 8008 44308 2308 2208

Chassis 1, Slot 9 (FPC09) 8009 44309 2309 2209
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Slot Address HTTP
(80) HTTPS (443) Telnet

(23) SSH (22)

Chassis 1, Slot 10 (FPC10) 8010 44310 2310 2210

For example:

l To connect to the GUI of the FPC slot 3 using HTTPS you would browse to https://192.168.1.99:44303.

The configuration is the same no matter whether you log into the management board or an FPC. Logging into
different FPCs allows you to use the FortiView or Monitor GUI pages to view the activity on that FPC. Even
though you can log into different FPCs, you should only make configuration changes from the management
board (slot 0 or MBD).

Connecting to individual FPC consoles

From the management board CLI, the execute system console-server command provides access to
individual FPC consoles in your FortiGate-6000. Console access can be useful for troubleshooting. For example,
if an FPC does not boot properly you can use console access to view the state of the FPC and enter commands to
fix the problem or restart the FPC.

From the console you can also restart the FPC and perform BIOS operations such as interrupting the boot to
install new firmware from the FortiGate-6000 internal TFTP server.

For example, from the management board CLI, use the following command to log into the console of the FPC in
slot 3:

execute system console-server connect 3

Authenticate to log into the console and use CLI commands to view information, make changes, or restart the
FPC. When you are done, use Ctrl-X to exit from the console back to the management board CLI.

Also from the management board CLI you can use the execute system console-server showline
command to list any active console server sessions. Only one console session can be active for each FPC, so
before connecting to an FPC console, you can use this command to verify whether or not there is an active
console session.

The following command output shows an active console session with the FPC in slot 4:

execute system console-server showline
MB console line connected - 1
Telnet-to-console line connected - 4

You can use the execute system console-server clearline command to clear an active console
session. For example, the clear an active console session with the FPC in slot 4, enter:

execute system console-server clearline 4

The execute system console-server commands only allow access to FPCs
in the FortiGate-6000 that you are logged into. You can't use this command to access
FPCs in the other FortiGate-6000 in an HA configuration.

Connecting to individual FPC CLIs

From the management board CLI you can use the following command to switch between FPCs and perform
different operations on the FPC in each slot:
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execute load-balance slot {manage | nmi-reset | power-off | power-on | reboot} <chassis-
number>.<slot-number>

Use manage to connect to the CLI of a different FPC, use the other options to perform an action on an individual
FPC.

For example, to connect to the NPC in chassis 1 slot 4 enter:

execute load-balance slot manage 1.4

For example, to rebook the NPC in chassis 1 slot 3 enter:

execute load-balance slot reboot 1.3

From the CLI you can also use the execute load-balance slot manage [<chassis>.]<slot>
command to log into the CLI of different components. You can use this command to view the status or
configuration of the FPC, restart the FPC, or perform other operations. You should not change the configuration
of individual FPCs because this can cause configuration synchronization errors.

<chassis> is the HA chassis ID and can be 1 or 2. The chassis ID is only required in an HA configuration where
you are attempting to log into the other chassis. In HA mode, if you skip the chassis ID you can log into another
component in the same chassis.

<slot> is the slot number of the component that you want to log into. The management board is in slot 0 and
the FPC slot numbers start at 1.

For example, in a FortiGate-6000 standalone configuration, if you have logged into the CLI of the management
board, enter the following command to log into the FPC in slot 5:

execute load-balance slot manage 5

In a FortiGate-6000 HA configuration, if you have logged into the CLI of the management board in chassis 1,
enter the following command to log into the FPC in chassis 2 slot 5:

execute load-balance slot manage 2.5

In a FortiGate-6000 HA configuration, if you have logged into the CLI of the management board in chassis 2,
enter the following command to log into the FPC in chassis 1 slot 3:

execute load-balance slot manage 1.3

In a FortiGate-6000 HA configuration, if you have logged into the CLI of the management board in chassis 1,
enter the following command to log into the FPC in slot 3 of the same chassis:

execute load-balance slot manage 3

After logging into a different component in this way, you can't use the execute load-balance slot
manage command to log into another component. Instead you need to use the exit command to revert back to
the CLI of the component that you originally logged into. Then you can use the execute load-balance
slot manage command to log into another component.

Connecting to FPC CLIs using the console port
You can use the front panel console port to connect to the CLI of the management board and individual FPCs.

By default when the FortiGate-6000 first starts up the console port is connected to the management board. The
default settings for connecting to the console port are:

Baud Rate (bps) 9600, Data bits 8, Parity None, Stop bits 1, and Flow Control None.
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If you connect a PC to the console port with a serial cable and open a terminal session you can press Ctrl-T to
enable console switching mode. Press Ctrl-T multiple times to cycle through the management board (MBD) and
FPC CLIs (the new destination is displayed in the terminal window).

Once the console port connects to the CLI that you want to use, press Enter to enable the CLI and login.

When your session is complete you can press Ctrl-T to connect to another CLI.

Connecting the CLI of an individual FPC

Use the following steps to connect to the CLI of the FPC in slot 4: (FPC04)

1. Connect the console cable supplied with your FortiGate-6000 to the console port and to your PC or other device
RS-232 console port.

2. Start a terminal emulation program on the PC. Use these settings:
Baud Rate (bps) 9600, Data bits 8, Parity None, Stop bits 1, and Flow Control None.

3. Press Ctrl-T to enter console switch mode.
4. Repeat pressing Ctrl-T until you have connected to FPC04. Example prompt:

<Switching to Console: FPC04 (9600)>

5. Login with an administrator name and password.
The default is admin with no password. For security reasons, it is strongly recommended that you change the
password.

6. When your session is complete, enter the exit command to log out.

Default VDOM and management VDOM configuration
By default when the FortiGate-6000 first starts up it is operating in multiple VDOM mode. The system has a
management VDOM (named mgmt-vdom) and the root VDOM. The ha1, ha2, mgmt1, mgmt2, and mgmt3
interfaces are in mgmt-vdom and all of the data interfaces (port1 to port28) are in the root VDOM.

For the FortiGate-6000 system to operate normally you should not change the configuration of the mgmt-vdom
VDOM and this VDOM should always be the management VDOM. You should also not add or remove interfaces
from this VDOM. You can change the IP addresses of the mgmt1, mgmt2, and mgmt3 interfaces and you can
add routes to the mgmt-vdom VDOM.

You have full control over the configurations of other FortiGate-6000 VDOMs.

Firmware upgrades
The management board and the FPCs in your FortiGate-6000 system run the same firmware image. You
upgrade the firmware from the management board GUI or CLI just as you would any FortiGate product. During
the upgrade process, the firmware running on the management board and all of the FPCs upgrades in one step.
Firmware upgrades should be done during a quiet time because traffic will briefly be interrupted during the
upgrade process. The entire firmware upgrade will take a few minutes depending on the number of FPCs in your
FortiGate-6000 system. Also, some firmware upgrades may take longer depending on factors such as the size of
the configuration and whether the an upgrade of the DP processor is included.

Before beginning a firmware upgrade, Fortinet recommends the following:

l Review the latest release notes for the firmware version that you are upgrading to.
l Verify the recommended upgrade path as documented in the release notes.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

627



Getting started with FortiGate-6000 Chapter 5 - FortiGate-6000

l Backup your FortiGate-6000 configuration.

Fortinet recommends that you review the services provided by your FortiGate-6000
before a firmware upgrade and then again after the upgrade to make sure everything
continues to operate normally. For example, you might want to verify that you can
successfully access an important server used by your organization before the upgrade
and make sure after the upgrade that you can still reach the server and that
performance is comparable. You could also take a snapshot of key performance
indicators (number of sessions, CPU usage, and memory usage) before the upgrade
and verify that you see comparable performance after the upgrade.

If you are operating two FortiGate-6000s in HAmode with uninterruptable-upgrade and session-
pickup enabled, firmware upgrades should only cause a minimal traffic interruption. Use the following
command to enable these settings. These settings are synchronized to all FPCs.

config system ha
set uninterruptable-upgrade enable
set session-pickup enable

end

Restarting the FortiGate-6000
To restart the FortiGate-6000, connect to the management board CLI and enter the command execute
reboot. When you enter this command the management board and all of the FPCs reboot.

You can restart individual FPCs by logging into that FPC's CLI and entering the execute reboot command.

NMI switch and NMI reset commands
When working with Fortinet Support to troubleshoot problems with your FortiGate-6000 you can use the front
panel non-maskable interrupt (NMI) switch to assist with troubleshooting. Pressing this switch causes the
software to dump management board registers and backtraces to the console. After the data is dumped, the
management board reboots. While the management board restarts, traffic is temporarily blocked. The
management board should restart normally and traffic can resume once the management board is up and
running.

You can use the following command to dump registers and backtraces of one or more FPCs to the console. After
the data is dumped, the FPCs reboot. While the FPCs are rebooting, traffic is distributed to the remaining FPCs.
The FPCs should restart normally and traffic can resume once they are up and running.

execute load-balance slot nmi-reset <slot-number(s)>

Where <slot-number(s)> can be one or more FPC slot numbers or slot number ranges with no space and
separated by commas. For example:

execute load-balance slot nmi-reset 1,3-4

Configuration synchronization
When you make configuration changes from the management board, FortiGate-6000 synchronizes these
configuration changes to the FPCs. To support configuration synchronization, the management board becomes
the config-sync master and makes sure the configurations of all FPCs are synchronized. Every time you make a
configuration change you must be logged in using the management address, which logs you into the
management board.
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You can use the diagnose sys confsync status | grep in_sy command to view the
synchronization status of the management board and FPCs. The following example just shows a few output
lines:

diagnose sys confsync status | grep in_sy

FPC6KF3E17900200, Slave, uptime=5385.45, priority=119, slot_id=2:1, idx=2, flag=0x4, in_sync=1

F6KF313E17900031, Slave, uptime=5484.74, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1

F6KF313E17900032, Master, uptime=5488.57, priority=1, slot_id=2:0, idx=1, flag=0x10, in_sync=1

FPC6KF3E17900201, Slave, uptime=5388.78, priority=120, slot_id=2:2, idx=2, flag=0x4, in_sync=1

F6KF313E17900031, Slave, uptime=5484.74, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1

...

The in_sync=1 field indicates that the FPC is synchronized.

Failover in a standalone FortiGate-6000
A FortiGate-6000 will continue to operate even if one of the FPCs fails. If an FPC fails, sessions being processed
by that FPC fail. All sessions are then load balanced to the remaining FPCs. Sessions that were being processed
by the failed FPC are restarted and load balanced to the remaining FPCs.

An FPC can fail due to a hardware malfunction, a software problem, or a power supply failure. The FortiGate-
6000 includes three hot-swappable power supplies in a 2+1 redundant configuration. At least two of the power
supplies must be operating to provide power to the FortiGate-6000. If only one power supply is operating then
some of the FPCs will be shut down. The FortiGate-6000 will continue to operate but with reduced performance
because fewer FPCs are operating.

If FPCs fail due to a hardware failure, they are not customer replaceable. Instead you should RMA the FortiGate-
6000.

You can use the diagnose load-balance status command to show the status of the FPCs. In the
command output, if Status Message is Running the FPC is operating normally. For example, for a
FortiGate-6301F:

diagnose load-balance status
==========================================================================
MBD SN: F6KF313E17900032

Master FPC Blade: slot-2

Slot 1: FPC6KF3E17900200
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 2: FPC6KF3E17900201
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 3: FPC6KF3E17900207
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"
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Slot 4: FPC6KF3E17900219
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 5: FPC6KF3E17900235
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 6: FPC6KF3E17900169
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Installing firmware on an individual FPC
You might want to install firmware on an individual FPC to resolve a software-related problem with the FPC or if
the FPC is not running the same firmware version as the management board. The following procedure describes
how to transfer a new firmware image file to the FortiGate-6000 internal TFTP server and then install the
firmware onto an FPC.

To install firmware on an individual FPC:

1. Copy the firmware image file onto a TFTP or FTP server, or USB key.
2. From the management board CLI, enter one of the following commands to upload the firmware image file onto

the FortiGate-6000 internal TFTP server. The command you use depends on whether the firmware image is on a
FTP server, TFTP server, or USB key.
execute upload image ftp <image-file-and-path> <comment> <ftp-server-address> <username>

<password>
execute upload image tftp <image-file> <comment> <tftp-server-address>
execute upload image usb <image-file-and path> <comment>

3. Enter the following command to install the firmware image file onto an FPC:
execute load-balance update image <slot-number>

Where <slot-number> is the FPC slot number.

This command uploads the firmware image to the FPC which then reboots. When the FPC starts up,
the configuration is reset to factory defaults and then synchronized by the management board. The
FPC reboots again, rejoins the cluster, and can start processing traffic.

4. Enter the following command to verify that the configuration of the FPC has been synchronized. The command
output below shows the sync status of some of the FPCs in an HA cluster of two FortiGate-6301Fs. The field in_
sync=1 indicates that the configuration of the FPC is synchronized.

FPC6KFT018901327, Slave, uptime=615368.33, priority=19, slot_id=1:1, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=615425.84, priority=1, slot_id=1:0, idx=0, flag=0x10, in_sync=1

FPC6KFT018901372, Slave, uptime=615319.63, priority=20, slot_id=1:2, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=615425.84, priority=1, slot_id=1:0, idx=0, flag=0x10, in_sync=1

FPC6KFT018901346, Slave, uptime=423.91, priority=21, slot_id=1:3, idx=1, flag=0x4, in_sync=1

If in_sync is not equal to 1 or if an FPC is missing in the command output you can try restarting the
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FPC by entering execute reboot from the CL of the out of synch FPC.

The command output also shows that the uptime of the FPC in slot 3 is lower than the uptime of the
other FPCs, indicating that the FPC in slot 3 has recently restarted.

Installing FortiGate-6000 firmware from the BIOS after a reboot
A common method for resetting the configuration of a FortiGate involves installing firmware by restarting the
FortiGate, interrupting the boot process, and using BIOS prompts to download a firmware image from a TFTP
server. This process is also considered the best way to reset the configuration of your FortiGate.

Installing or upgrading FortiGate-6000 firmware from the BIOS after a reboot installs
firmware on and resets the configuration of the management board only. The FPCs
will continue to operate with their current configuration and firmware build. The
FortiGate-6000 system does not synchronize firmware upgrades performed from the
BIOS. Once you have installed firmware on the management board from the BIOS
after a reboot you must synchronize the new firmware build and configuration to the
FPCs.

Use the following steps to upload firmware from a TFTP server to the management board. The procedure
involves creating a connection between the TFTP server and one of the FortiGate-6000 MGMT interfaces (in the
example, mgmt1).

This procedure also involves connecting to the management board CLI using the FortiGate-6000 console port,
rebooting the management board, interrupting the boot from the console session, and following management
BIOS prompts to install the firmware. During this procedure, the FortiGate-6000 will not be able to process traffic.

1. Set up a TFTP server and copy the firmware file to the TFTP server default folder.
2. Set up your network to allow traffic between the TFTP server and one of the MGMT interfaces.
3. Connect the console cable supplied with your FortiGate-6000 to the front panel Console port and to your

management computer's RS-232 console port.
4. Start a terminal emulation program on the management computer. Use these settings:

Baud Rate (bps) 9600, Data bits 8, Parity None, Stop bits 1, and Flow Control None.
5. Log into the management board CLI.
6. Enter the config global command to enter the global configuration.
7. Enter execute reboot to restart the management board.
8. When the management board starts up, follow the boot process in the terminal session and press any key when

prompted to interrupt the boot process.
9. Press C to set up the TFTP configuration.
10. Use the BIOSmenu to set the following. Only change settings if required.

[P]: Set image download port: MGMT1

[D]: Set DHCP mode: Disabled

[I]: Set local IP address: The IP address of the MGMT interface, to be used to connect to the
TFTP server. This address can be the same as the FortiGate-6000 management IP address and cannot
conflict with other addresses on your network.

[S]: Set local Subnet Mask: Set as required for your network.

[G]: Set local gateway: Set as required for your network.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

631



Getting started with FortiGate-6000 Chapter 5 - FortiGate-6000

[V]: Local VLAN ID: Should be set to <none>. Use -1 to set the Local VLAN ID to <none>.

[T]: Set remote TFTP server IP address: The IP address of the TFTP server.

[F]: Set firmware image file name: The name of the firmware file to be installed.

11. Press Q to quit this menu.
12. Press R to review the configuration.

If you need to make any corrections, press C and make the changes as required. When the configuration is
correct, proceed to the next step.

13. Press T to start the TFTP transfer.
The management board downloads the firmware image from the TFTP server and installs on the management
board. The management board then restarts with the configuration reset to factory defaults.

14. Once the management restarts, verify that the correct firmware has been installed.
You can do this from the management board GUI dashboard or from the CLI using the get system status
command.

15. Continue by using the following procedure to synchronize all of the FPCs with the management board.

Synchronizing the FPCs with the management board

After installing firmware on the management board from the BIOS after a reboot, the firmware version and
configuration of the management board will most likely be out of synch with the FPCs. You can verify this from
the management board CLI using the diagnose sys confsync status | grep in_sy command. The
in_sync=0 entries in the following output for a FortiGate-6301F show that the management board (serial
number ending in 143) is out of sync with all of the FPCs.

diagnose sys confsync status | grep in_sy

FPC6KFT018901327, Slave, uptime=59.44, priority=19, slot_id=1:1, idx=1, flag=0x4, in_sync=0

F6KF31T018900143, Master, uptime=119.72, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901372, Slave, uptime=58.48, priority=20, slot_id=1:2, idx=1, flag=0x4, in_sync=0

F6KF31T018900143, Master, uptime=119.72, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901346, Slave, uptime=58.44, priority=21, slot_id=1:3, idx=1, flag=0x4, in_sync=0

F6KF31T018900143, Master, uptime=119.72, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901574, Slave, uptime=58.43, priority=22, slot_id=1:4, idx=1, flag=0x4, in_sync=0

F6KF31T018900143, Master, uptime=119.72, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901345, Slave, uptime=57.40, priority=23, slot_id=1:5, idx=1, flag=0x4, in_sync=0

F6KF31T018900143, Master, uptime=119.72, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901556, Slave, uptime=58.43, priority=24, slot_id=1:6, idx=1, flag=0x4, in_sync=0

F6KF31T018900143, Master, uptime=119.72, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

F6KF31T018900143, Master, uptime=119.72, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901327, Slave, uptime=59.44, priority=19, slot_id=1:1, idx=1, flag=0x4, in_sync=0

FPC6KFT018901345, Slave, uptime=57.40, priority=23, slot_id=1:5, idx=2, flag=0x4, in_sync=0

FPC6KFT018901346, Slave, uptime=58.44, priority=21, slot_id=1:3, idx=3, flag=0x4, in_sync=0

FPC6KFT018901372, Slave, uptime=58.48, priority=20, slot_id=1:2, idx=4, flag=0x4, in_sync=0

FPC6KFT018901556, Slave, uptime=58.43, priority=24, slot_id=1:6, idx=5, flag=0x4, in_sync=0

FPC6KFT018901574, Slave, uptime=58.43, priority=22, slot_id=1:4, idx=6, flag=0x4, in_sync=0

You can also verify synchronization status from management board Security Fabric dashboard widget.

To re-synchronize the FortiGate-6000 (which has the effect of resetting all of the FPCs), you can install firmware
on the management board using a normal firmware install processes.
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You could also manually install firmware on each individual FPC from the BIOS after a
reboot. This manual process is just as effective as installing the firmware for a second
time on the management board to trigger synchronization to the FPCs, but takes
much longer.

1. Log into the management board GUI.
2. Click the System Information dashboard widget select Update firmware in System > Firmware.

You can also connect to the management board CLI and use the execute restore image command. Either
operation synchronizes the firmware build and configuration from the management board to the FPCs. The
firmware build you install on the management board can either be the same firmware build or a different one.

3. Once you have installed or re-installed firmware on the management board, check the synchronization status from
the Security Fabric dashboard widget or by using the the diagnose sys confsync status | grep in_
sy command. The output should be similar to the following (shown for a ForGate-6301F):

diagnose sys confsync status | grep in_sy

FPC6KFT018901327, Slave, uptime=3773.96, priority=19, slot_id=1:1, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=3837.25, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901372, Slave, uptime=3774.26, priority=20, slot_id=1:2, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=3837.25, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901346, Slave, uptime=3774.68, priority=21, slot_id=1:3, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=3837.25, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901574, Slave, uptime=3774.19, priority=22, slot_id=1:4, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=3837.25, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901345, Slave, uptime=3773.59, priority=23, slot_id=1:5, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=3837.25, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901556, Slave, uptime=3774.82, priority=24, slot_id=1:6, idx=1, flag=0x4, in_sync=1

F6KF31T018900143, Master, uptime=3837.25, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

F6KF31T018900143, Master, uptime=3837.25, priority=1, slot_id=1:0, idx=0, flag=0x0, in_sync=1

FPC6KFT018901327, Slave, uptime=3773.96, priority=19, slot_id=1:1, idx=1, flag=0x24, in_sync=1

FPC6KFT018901345, Slave, uptime=3773.59, priority=23, slot_id=1:5, idx=2, flag=0x24, in_sync=1

FPC6KFT018901346, Slave, uptime=3774.68, priority=21, slot_id=1:3, idx=3, flag=0x24, in_sync=1

FPC6KFT018901372, Slave, uptime=3774.26, priority=20, slot_id=1:2, idx=4, flag=0x24, in_sync=1

FPC6KFT018901556, Slave, uptime=3774.82, priority=24, slot_id=1:6, idx=5, flag=0x24, in_sync=1

FPC6KFT018901574, Slave, uptime=3774.19, priority=22, slot_id=1:4, idx=6, flag=0x24, in_sync=1

Packet sniffing for FPC and management board packets
From the management board CLI, you can use the diagnose sniffer packet command to view or sniff
packets processed by the FPCs. To use this command log into the management board and edit a VDOM. This
command includes a <slot> option to allow you to view packets processed by individual FPCs.

You can the diagnose sniffer packet command from an individual FPC CLO
to view packets processed by that FPC.

From the management board the command syntax is:

diagnose sniffer packet <interface> <protocol-filter> <verbose> <count> <timestamp> <slot>

Where:
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<interface> the name of one or more interfaces on which to sniff for packets. Use any to sniff packets for all
interfaces.

<protocol-filter> a filter to select the protocol for which to view traffic. This can be simple, such as
entering udp to view UDP traffic or complex to specify a protocol, port, and source and destination interface and
so on.

<verbose> the amount of detail in the output, and can be:

1 display packet headers only.

2 display packet headers and IP data.

3 display packet headers and Ethernet data (if available).

4 display packet headers and interface names.

5 display packet headers, IP data, and interface names.

6 display packet headers, Ethernet data (if available), and interface names.

<count> the number of packets to view. You can enter Ctrl-C to stop the sniffer before the count is reached.

<timestamp> the timestamp format, a for UTC time and l for local time.

<slot> the FPC(s) for which to view packets.

l To view packets for one FPC enter the FPC's slot number.
l To view packets for more than one FPC, enter the slot numbers separated by commas. You can also include a

range. For example, to view packets for the FPCs in slots 1, 2, 3, and 6 you can enter 1,2,3,6 or 1-3,6.
l To view packets for all FPCs, enter all.
l If you leave out the <slot> option, you can use the diagnose sniffer options slot command to set

whether management board packets appear or whether management board and FPC packets appear.

Using the diagnose sniffer options slot command

You can use the diagnose sniffer options slot command to control what the diagnose sniffer
packet command displays if you don't include the <slot> option. The default diagnose sniffer
options slot setting causes the diagnose sniffer packet command to display packets processed by
all FPCs and by the management board.

You can use the following command to only display packets processed by the management board:

diagnose sniffer options slot current

Then the next time you enter the diagnose sniffer packet command and leave out the <slot> option,
only packets from the management board appear in the command output.

Filtering out internal management traffic

The FortiGate-6000 includes internal interfaces that process internal management and synchronization
communication between FortiGate-6000 components. Because this traffic uses internal interfaces, if you specify
one or more interface names in the diagnose sniffer packet command this traffic is filtered out.
However, if you sniff traffic on any interface, internal management traffic can appear in the diagnose
sniffer packet command output.
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The diagnose sniffer options filter-out-internal-pkts option if enabled (the default),
filters out this internal management traffic. You can disable this option if you want to see the internal
management traffic in the diagnose sniffer packet output.
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Load balancing and flow rules

This chapter provides an overview of how FortiGate-6000 Session-Aware Load Balancing (SLBC) works and then
breaks down the details and explains why you might want to change some load balancing settings.

For information about IP sec load balancing, see FortiGate-6000 IPsec VPN on page
645.

FortiGate-6000 SLBC works as follows.

1. SLBC attempts to match all incoming sessions with a configured flow rule (see Load balancing and flow rules on
page 636). If a session matches a flow rule, the session is directed according to the action setting of the flow rule.
Usually flow rules send traffic that can't be load balanced to a specific FPC.

2. TCP, UDP, SCTP, ICMP (IPv4 only) and ESP (IPv4 only) sessions that do not match a flow rule are directed to the
DP3 processors.
The DP3 processors distribute sessions to the FPCs according to the load balancing method set by the dp-
load-distribution-method option of the config load-balance setting command.

3. All other sessions are sent to the primary (or master) FPC.

Setting the load balancing method
The FortiGate-6000 load balances or distributes sessions based on the load balancing method set by the
following command:

config load-balance setting
set dp-load-distribution-method {to-master | src-ip | dst-ip | src-dst-ip | src-ip-

sport | dst-ip-dport | src-dst-ip-sport-dport}
end

Where:

to-master directs all session to the primary FPC. For troubleshooting only and should not be used for normal
operation. Directing all sessions to the primary FPC has a negative impact on performance.

src-ip distribute sessions across all FPCs according to their source IP address.

dst-ip distribute sessions statically distributed across all FPCs according to their destination IP address.

src-dst-ip distribute sessions across all FPCs according to their source and destination IP addresses.

src-ip-sport distribute sessions across all FPCs according to their source IP address and source port.

dst-ip-dport distribute sessions across all FPCs according to their destination IP address and destination
port.

src-dst-ipsport-dport distribute sessions across all FPCs according to their source and destination IP
address, source port, and destination port. This is the default load balance algorithm and represents true session-
aware load balancing. Session aware load balancing takes all session information into account when deciding
where to send new sessions and where to send additional packets that are part of an already established session.
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The src-ip and dst-ip load balancing methods use layer 3 information (IP addresses) to identify and load
balance sessions. All of the other load balancing methods (except for to-master) use both layer 3 and layer 4
information (IP addresses and port numbers) to identify a TCP and UDP session. The layer 3 and layer 4 load
balancing methods only use layer 3 information for other types of traffic (SCTP, ICMP, and ESP). If you enable
GTP load balancing, the FortiGate-6000 uses Tunnel Endpoint Identifiers (TEIDs) to identify GTP sessions.

Flow rules for sessions that cannot be load balanced
Some traffic types cannot be load balanced. Sessions for traffic types that cannot be load balanced should
normally be sent to the primary (or master) FPC by configuring flow rules for that traffic. You can also configure
flow rules to send traffic that cannot be load balanced to specific FPCs.

Create flow rules using the config loadbalance flow-rule command. The default configuration uses
this command to send IKE, GRE, session helper, Kerberos, BGP, RIP, IPv4 and IPv6 DHCP, PPTP, BFD, IPv4
multicast and IPv6 multicast to the primary FPC. You can view the default configuration of the config
loadbalance flow-rule command to see how this is all configured. For example, the following
configuration sends all IKE sessions to the primary FPC:

config load-balance flow-rule
edit 1

set status enable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 500-500
set dst-l4port 500-500
set action forward
set forward-slot master
set priority 5
set comment "ike"

next
edit 2

set status disable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 4500-4500
set dst-l4port 0-0
set action forward
set forward-slot master
set priority 5
set comment "ike-natt src"

next
edit 3

set status disable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 0-0
set dst-l4port 4500-4500
set action forward
set forward-slot master
set priority 5
set comment "ike-natt dst"

next
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See Default configuration for traffic that cannot be load balanced on page 640 for a listing of all of the default flow
rules.

Here is a list of protocols that are not load balanced, but sent to the primary FPC. You can create flow rules to
change this behavior:

l IPv4 over IPv6
l IPv6 over IPv4
l IP over IP
l L2TP

Determining which FPC is operating as the primary FPC
You can use the diagnose load-balance status command to determine which FPC is operating as the
primary FPC. The primary FPC is also responsible for dynamic routing.

The following example diagnose load-balance status output for a FortiGate-6300F shows that the
FPC in slot 1 is the primary (master) FPC. The command output also shows the status of all of the FPCs in the
FortiGate-6300F.

diagnose load-balance status
==========================================================================
MBD SN: F6KF313E17900032

Master FPC Blade: slot-1

Slot 1: FPC6KF3E1790020
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 2: FPC6KF3E17900201
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 3: FPC6KF3E17900207
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 4: FPC6KF3E17900219
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 5: FPC6KF3E17900235
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 6: FPC6KF3E17900169
Status:Working Function:Active
Link: Base: Up Fabric: Up
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Heartbeat: Management: Good Data: Good
Status Message:"Running"

SSL VPN load balancing
FortiGate-6000s do not support load balancing SSL VPN sessions terminated by the FortiGate-6000. The
recommended configuration is to direct SSL VPN sessions terminated by the FortiGate-6000 to the primary FPC.

SSL VPN sessions are sessions from an SSL VPN client to your configured SSL VPN
server listening port.

Using a FortiGate-6000 as an SSL VPN server requires you to manually add an SSL VPN load balance flow rule to
configure the FortiGate-6000 to send all SSL VPN sessions to the primary (master) FPC. To match with the SSL
VPN server traffic, the rule should include a destination port that matches the destination port of the SSL VPN
server. A basic rule to allow SSL VPN traffic could be:

config load-balance flow-rule
edit 0

set status enable
set ether-type ipv4
set protocol tcp
set dst-l4port 10443-10443
set forward-slot master
set comment "ssl vpn server to primary FPC"

next
end

This flow rule matches all sessions sent to port 10443 (the default SSL VPN server listening port) and sends these
sessions to the primary FPC. This should match all of your SSL VPN traffic if you are using the default SSL
VPN server listening port (10443). This flow rule also matches all other sessions using 10443 as the destination
port so all of this traffic is also sent to the primary FPC.

Adding the SSL VPN server IP address

You can add the IP address of the FortiGate-6000 interface that receives SSL VPN traffic to the SSL VPN flow
rule to make sure that the flow rule only matches SSL VPN server settings. For example, if the IP address of the
interface is 172.25.176.32 and the SSL VPN flow rule ID is 26:

config load-balance flow-rule
edit 26

set status enable
set ether-type ipv4
set protocol tcp
set dst-addr-ipv4 172.25.176.32 255.255.255.0
set dst-l4port 10443-10443
set forward-slot master
set comment "ssl vpn server to primary FPC"

next
end

This flow rule will now only match SSL VPN sessions with 172.25.176.32 as the destination address and send all
of these sessions to the primary FPC.
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If you change the SSL VPN server listening port

If you have changed the SSL VPN server listening port to 20443, you can change the SSL VPN flow rule as
follows. This example also sets the source interface to port12, which is the SSL VPN server interfaces, instead of
adding the IP address of port12 to the configuration:

config load-balance flow-rule
edit 26

set status enable
set ether-type ipv4
set protocol tcp
set src-interface port12
set dst-l4port 20443-20443
set forward-slot master
set comment "ssl vpn server to primary FPC"

next
end

GTP load balancing
You can use the following command to enable or disable GTP load balancing.

config load-balance setting
set gtp-load-balance {disable | enable}

end

By default, this option is disabled and GTP load balancing is disabled. Instead, the following flow rule is enabled
and GTP traffic is directed to the primary (master) FPC.

config load-balance flow-rule
edit 17

set status enable
set ether-type ipv4
set protocol udp
set dst-l4port 546-546
set dst-l4port 2123-2123
set comment "gtp-c to master blade"

next
end

When the gtp-load-balance option is enabled, the GTP load balancing is flow rule is disabled and the
FortiGate-6000 directs GTP sessions to the DP3 processors where they are load balanced to the FPCs.

Default configuration for traffic that cannot be load balanced
The default FortiGate-6000 configure load-balance flow-rule command contains the recommended
default rules for how the FortiGate-6000 handles traffic types that cannot be load balanced. All of these flow rules
identify the traffic type using the options available in the command and direct the traffic to the primary (or master)
FPC. The rules also include a comment that identifies the traffic type.

Most of the flow rules are enabled (status set to enable) and they will direct matching traffic to the primary
FPC. However, the configuration does include some disabled flow rules. You can enable these flow rules if
required for your network.
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The CLI syntax below was created with the show command and just shows the configuration changes. All other
options are set to their defaults. Flow rules with no status option are disabled be default. Also the default
forward-slot setting is master, which directs matching traffic to the primary FPC.

show load-balance flow-rule
config load-balance flow-rule

edit 1
set ether-type ip
set protocol udp
set src-l4port 88-88
set comment "kerberos src"

next
edit 2

set ether-type ip
set protocol udp
set dst-l4port 88-88
set comment "kerberos dst"

next
edit 3

set status enable
set ether-type ip
set protocol tcp
set src-l4port 179-179
set comment "bgp src"

next
edit 4

set status enable
set ether-type ip
set protocol tcp
set dst-l4port 179-179
set comment "bgp dst"

next
edit 5

set status enable
set ether-type ip
set protocol udp
set src-l4port 520-520
set dst-l4port 520-520
set comment "rip"

next
edit 6

set status enable
set ether-type ipv6
set protocol udp
set src-l4port 521-521
set dst-l4port 521-521
set comment "ripng"

next
edit 7

set status enable
set ether-type ipv4
set protocol udp
set src-l4port 67-67
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set dst-l4port 68-68
set comment "dhcpv4 server to client"

next
edit 8

set status enable
set ether-type ipv4
set protocol udp
set src-l4port 68-68
set dst-l4port 67-67
set comment "dhcpv4 client to server"

next
edit 9

set ether-type ip
set protocol tcp
set src-l4port 1723-1723
set comment "pptp src"

next
edit 10

set ether-type ip
set protocol tcp
set dst-l4port 1723-1723
set comment "pptp dst"

next
edit 11

set status enable
set ether-type ip
set protocol udp
set dst-l4port 3784-3784
set comment "bfd control"

next
edit 12

set status enable
set ether-type ip
set protocol udp
set dst-l4port 3785-3785
set comment "bfd echo"

next
edit 13

set status enable
set ether-type ipv6
set protocol udp
set src-l4port 547-547
set dst-l4port 546-546
set comment "dhcpv6 server to client"

next
edit 14

set status enable
set ether-type ipv6
set protocol udp
set src-l4port 546-546
set dst-l4port 547-547
set comment "dhcpv6 client to server"
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next
edit 15

set status enable
set ether-type ipv4
set dst-addr-ipv4 224.0.0.0 240.0.0.0
set comment "ipv4 multicast"

next
edit 16

set status enable
set ether-type ipv6
set dst-addr-ipv6 ff00::/8
set comment "ipv6 multicast"

next
edit 17

set ether-type ipv4
set protocol udp
set dst-l4port 2123-2123
set comment "gtp-c to master blade"

next
edit 18

set status enable
set ether-type ipv6
set protocol udp
set dst-l4port 500-500
set comment "ipv6 ike"

next
edit 19

set status enable
set ether-type ipv6
set protocol udp
set dst-l4port 4500-4500
set comment "ipv6 ike-natt dst"

next
edit 20

set status enable
set ether-type ipv6
set protocol esp
set comment "ipv6 esp"

next
edit 21

set status enable
set ether-type ipv4
set protocol udp
set dst-l4port 500-500
set comment "ipv4 ike"

next
edit 22

set status enable
set ether-type ipv4
set protocol udp
set dst-l4port 4500-4500
set comment "ipv4 ike-natt dst"
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next
edit 23

set status enable
set ether-type ipv4
set protocol esp
set comment "ipv4 esp"

next
edit 24

set status enable
set ether-type ip
set protocol tcp
set dst-l4port 1000-1000
set comment "authd http to master blade"

next
edit 25

set status enable
set ether-type ip
set protocol tcp
set dst-l4port 1003-1003
set comment "authd https to master blade"

next
edit 26

set status enable
set ether-type ip
set protocol vrrp
set forward-slot all
set priority 6
set comment "vrrp to all blades"

next
end
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This chapter highlights special FortiGate-6000 VPN features and configurations.

New IPsec VPN features
FortiOS 5.6 includes the following IPsec VPN improvements:

l Including a phase 2 selector is no longer mandatory.
l Dynamic routing (RIP, OSPF, BGP) is supported over IPsec VPN tunnels.

IPsec VPN features supported by FortiOS 5.6 for FortiGate-6000

FortiOS 5.6 for FortiGate-7000 supports the following IPsec VPN features.

l Interface-based IPsec VPN (also called route-based IPsec VPN).
l Static routes can point IPsec VPN interfaces.
l Dynamic routing (RIP, OSPF, BGP) over IPsec VPN tunnels.
l Remote networks with 16- to 32-bit netmasks.
l IPsec VPN tunnels must terminate on the primary FPM (the ELBCmaster).
l Site-to-Site IPsec VPN.
l Dialup IPsec VPN. The FortiGate-7000 can be the dialup server or client.
l IPv4 clear-text traffic (IPv4 over IPv4 or IPv4 over IPv6)

IPsec VPN features not supported by FortiOS 5.6 for FortiGate-6000

FortiOS 5.6 for FortiGate-7000 does not support the following IPsec VPN features.

l Policy-based IPsec VPN.
l Policy routes for VPN traffic.
l Remote networks with 0- to 15-bit netmasks.
l IPv6 clear-text traffic (IPv6 over IPv4 or IPv6 over IPv6).
l Load-balancing IPsec VPN tunnels to multiple FPMs.
l IPsec SA synchronization between both FortiGate-7000s in an HA configuration.

IPsec VPN load balancing
You can use the following command to enable or disable IPsec VPN load balancing:

config load-balance setting
config ipsec-load-balance {disable | enable}

end

By default IPsec VPN load balancing is enabled and the flow rules listed below are disabled. The FortiGate-6000
directs IPsec VPN sessions to the DP3 processors which load balances them among the FPCs.

However, with IPsec VPN load balancing enabled, the FortiGate-6000 will drop IPsec VPN sessions traveling
between two IPsec tunnels because the two IPsec tunnels may be terminated on different FPCs. So if you have
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traffic entering the FortiGate-6000 from one IPsec VPN tunnel and leaving the FortiGate-6000 out another IPsec
VPN tunnel you need to disable IPsec load balancing:

config load-balance setting
config ipsec-load-balance disable

end

Disabling IPsec VPN load balancing in this way enables the following flow rules:

config load-balance flow-rule
edit 21

set ether-type ipv4
set protocol udp
set dst-l4port 500-500
set comment "ipv4 ike"

next
edit 24

set ether-type ipv4
set protocol udp
set dst-l4port 4500-4500
set comment "ipv4 ike-natt dst"

next
edit 25

set ether-type ipv4
set protocol esp
set comment "ipv4 esp"

next
end

These flow rules should generally handle all IPsec VPN traffic. You can also adjust them or add your own flow
rules if you have an IPsec VPN setup that is not compatible with the default flow rules.

Adding source and destination subnets to IPsec VPN phase 2 configurations
If your FortiGate-6000 configuration includes IPsec VPNs you should enhance your IPsec VPN Phase 2
configurations as described in this section. Because the FortiGate-6000 only allows 16-bit to 32-bit routes, you
must add one or more destination subnets to your IPsec VPN phase 2 configuration for FortiGate-6000 using the
following command:

config vpn ipsec phase2-interface
edit "to_fgt2"

set phase1name <name>
set src-subnet <IP> <netmask>
set dst-subnet <IP> <netmask>

end

Where

src-subnet is the subnet protected by the FortiGate-6000 that you are configuring and from which users
connect to the destination subnet. Configuring the source subnet is optional but recommended.

dst-subnet is the destination subnet behind the remote IPsec VPN endpoint. Configuring the destination
subnet is required.
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Example basic IPsec VPN Phase 2 configuration

In a simple configuration such as the one below with an IPsec VPN between two remote subnets you can just add
the subnets to the phase 2 configuration.

Enter the following command to add the source and destination subnets to the FortiGate-6000 IPsec VPN Phase
2 configuration.

config vpn ipsec phase2-interface
edit "to_fgt2"

set phase1name "to_fgt2"
set src-subnet 172.16.1.0 255.255.255.0
set dst-subnet 172.16.2.0 255.255.255.0

end

Example multiple subnet IPsec VPN Phase 2 configuration

In a more complex configuration, such as the one below with a total of 5 subnets you still need to add all of the
subnets to the Phase 2 configuration. In this case you can create a firewall address for each subnet and the
addresses to address groups and add the address groups to the Phase 2 configuration.

Enter the following commands to create firewall addresses for each subnet.

config firewall address
edit "local_subnet_1"
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set subnet 4.2.1.0 255.255.255.0
next
edit "local_subnet_2"

set subnet 4.2.2.0 255.255.255.0
next
edit "remote_subnet_3"

set subnet 4.2.3.0 255.255.255.0
next
edit "remote_subnet_4"

set subnet 4.2.4.0 255.255.255.0
next
edit "remote_subnet_5"

set subnet 4.2.5.0 255.255.255.0
end

And then put the five firewall addresses into two firewall address groups.

config firewall addrgrp
edit "local_group"

set member "local_subnet_1" "local_subnet_2"
next
edit "remote_group"

set member "remote_subnet_3" "remote_subnet_4" "remote_subnet_5"
end

Now, use the firewall address groups in the Phase 2 configuration:

config vpn ipsec phase2-interface
edit "to-fgt2"

set phase1name "to-fgt2"
set src-addr-type name
set dst-addr-type name
set src-name "local_group"
set dst-name "remote_group"

end

Configuring the FortiGate-6000 as a dialup IPsec VPN server
FortiGate-6000s can be configured as dialup IPsec VPN servers.

Example dialup IPsec VPN configuration

The following shows how to setup a dialup IPsec VPN configuration where the FortiGate-6000 acts as a dialup
IPsec VPN server.
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To configure the FortiGate-6000 as a dialup IPsec VPN server

Configure the phase1, set type to dynamic.

config vpn ipsec phase1-interface
edit dialup-server

set type dynamic
set interface "v0020"
set peertype any
set psksecret < password>

end

Configure the phase 2, to support dialup IPsec VPN, set the destination subnet to 0.0.0.0 0.0.0.0.

config vpn ipsec phase2-interface
edit dialup-server

set phase1name dialup-server
set src-subnet 4.2.0.0 255.255.0.0
set dst-subnet 0.0.0.0 0.0.0.0

end

To configure the remote FortiGate as a dialup IPsec VPN client

The dialup IPsec VPN client should advertise its local subnet(s) using the phase 2 src-subnet option.

If there are multiple local subnets, create a phase 2 for each one. Each phase 2 only
advertises one local subnet to the dialup IPsec VPN server. If more than one local
subnet is added to the phase 2, only the first one is advertised to the server.

Dialup client configuration:

config vpn ipsec phase1-interface
edit "to-fgt6k"

set interface "v0020"
set peertype any
set remote-gw 1.2.0.1
set psksecret <password>

end
config vpn ipsec phase2-interface

edit "to-fgt6k"
set phase1name "to-fgt6k"
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set src-subnet 4.2.6.0 255.255.255.0
set dst-subnet 4.2.0.0 255.255.0.0

next
edit "to-fgt6k-2"

set phase1name "to-fgt6k"
set src-subnet 4.2.7.0 255.255.255.0
set dst-subnet 4.2.0.0 255.255.0.0

end
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FortiGate-6000 supports FortiGate Clustering Protocol (FGCP) HA between two (and only two) identical
FortiGate-6000 models. You can configure FortiGate-6000 HA in much the same way as any FortiGate HA setup
except that you must use the HA1 and HA2 interfaces for HA heartbeat communication. Also, the heartbeat
packets are VLAN-tagged and you can configure the VLANs used. Also, FortiGate-6000 HA only supports Active-
Passive HA and even though the FortiGate-6000s are configured with multiple VDOMs they do not support virtual
clustering.

During the FortiGate-6000 HA configuration you assign each of the FortiGate-6000s in the HA cluster a chassis
ID of 1 or 2. The chassis IDs just allow you to identify individual FortiGate-6000s and do not influence primary unit
selection.

Example FortiGate-6000 HA configuration

In a FortiGate-6000 FGCPHA configuration, the primary (or master) FortiGate-6000 processes all traffic. The
backup FortiGate-6000 operates in hot standby mode. The FGCP synchronizes the configuration, active
sessions, routing information, and so on to the backup FortiGate-6000. If the primary FortiGate-6000 fails, traffic
automatically fails over to the backup.

The FGCP selects the primary FortiGate-6000 based on standard FGCP primary unit selection:

l Connected monitored interfaces
l Age
l Device Priority
l Serial Number
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In most cases, if everything is connected and operating normally, the FortiGate-6000 with the highest serial
number becomes the primary FortiGate-6000. You can set the device priority higher on one of the FortiGate-
6000s if you want to it to become the primary unit. You can also enable override along with setting a higher device
priority to make sure the same FortiGae-6000 always becomes the primary FortiGate-6000.

Session terminated by the cluster include management sessions (such as HTTPS connections to the FortiGate
GUI or SSH connection to the CLI as well as SNMP and logging and so on). Also included in this category are
IPsec VPN, SSL VPN, sessions terminated by the cluster, and explicit proxy sessions. In general, whether or not
session-pickup is enabled, these sessions do not failover and have to be restarted.

Before you begin configuring HA
Before you begin, the FortiGate-6000s should be running the same FortiOS firmware version and interfaces
should not be configured to get their addresses from DHCP or PPPoE. Register and apply licenses to each
FortiGate-6000 before setting up the HA cluster. This includes licensing for FortiCare, IPS, AntiVirus, Web
Filtering, Mobile Malware, FortiClient, FortiCloud, and additional virtual domains (VDOMs). Both FortiGate-
6000s in the cluster must have the same level of licensing for FortiGuard, FortiCloud, FortiClient, and VDOMs.
FortiToken licenses can be added at any time because they are synchronized to all cluster members.

On each FortiGate-6000, make sure the configurations of the FPCs are synchronized before starting to configure
HA. You can use the following command to verify the configuration status of the FPCs. The following example
shows the results from a FortiGate-6300F.

diagnose sys confsync showchsum | grep all
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e

If the FPCs are synchronized, the listed checksums should all be the same.

You can also use the following command to list the FPCs that are synchronized. The example output, for a
FortiGate-6300F, shows all six FPCs have been configured for HA and added to the cluster.

diagnose sys confsync status | grep in_sync
F6KF313E17900031, Slave, uptime=232441.23, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1
F6KF313E17900031, Slave, uptime=232441.23, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1
F6KF313E17900031, Slave, uptime=232441.23, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1
F6KF313E17900031, Slave, uptime=232441.23, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1
F6KF313E17900031, Slave, uptime=232441.23, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1
F6KF313E17900031, Master, uptime=232441.23, priority=1, slot_id=1:0, idx=0, flag=0x10, in_sync=1
F6KF313E17900031, Slave, uptime=232441.23, priority=2, slot_id=1:0, idx=0, flag=0x10, in_sync=1
FPC6KF3E17900209, Slave, uptime=231561.99, priority=24, slot_id=1:6, idx=6, flag=0x24, in_sync=1
FPC6KF3E17900215, Slave, uptime=231524.81, priority=22, slot_id=1:4, idx=7, flag=0x24, in_sync=1
FPC6KF3E17900217, Slave, uptime=232289.83, priority=120, slot_id=1:5, idx=8, flag=0x24, in_sync=1
FPC6KF3E17900229, Slave, uptime=232271.59, priority=118, slot_id=1:3, idx=10, flag=0x24, in_sync=1
FPC6KF3E17900230, Slave, uptime=232330.19, priority=116, slot_id=1:1, idx=11, flag=0x24, in_sync=1
FPC6KF3E17900291, Slave, uptime=232314.29, priority=117, slot_id=1:2, idx=13, flag=0x24, in_sync=1

In this command output in_sync=1 means the FPC is synchronized with the management board and in_
sync=0 means the FPC is not synchronized.

652 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 5 - FortiGate-6000 FortiGate-6000 high availability (FGCP)

Connect the HA1 and HA2 interfaces for HA heartbeat communication
HA heartbeat communication between FortiGate-6000s happens over the 10Gbit HA1 and HA2 interfaces. To set
up HA heartbeat connections:

l Connect the HA1 interfaces of the two FortiGate-6000s together either with a direct cable connection, or using a
switch.

l Connect the HA2 interfaces in the same way.

Heartbeat packets are VLAN packets with VLAN ID 999 and ethertype 9890. The MTU value for the HA1 and HA2
interfaces is 1500. You can use the following commands to change the HA heartbeat packet VLAN ID and
ethertype values if required for your switches. You must change these settings on each FortiGate-6000. By
default the HA1 and HA2 interface heartbeat packets use the same VLAN IDs.

config system ha
set hbdev-vlan-id <vlan>
set hbdev-second-vlan-id <vlan>
set ha-eth-type <eth-type>

end

Using separate connections for HA1 and HA2 is recommended for redundancy. If you
are using switches, it is also recommended that these switches be dedicated to HA
heartbeat communication and not used for other traffic.

If you use the same switch for both HA1 and HA2, separate the HA1 and HA2 traffic on
the switch and set the heartbeat traffic on the HA1 and HA2 Interfaces to have
different VLAN IDs. For example, use the following command to set the heartbeat
traffic on HA1 to use VLAN ID 4091 and the heartbeat traffic on HA2 to use VLAN ID
4092:

  config system ha
    set hbdev-vlan-id 4091
    set hbdev-second-vlan-id 4092
  end

If you don't set different VLAN IDs for the HA1 and HA2 heartbeat packets, q-in-q must
be enabled on the switch.

Example FortiGate-6000 switch configuration

The switch that you use for connecting HA heartbeat interfaces does not have to support IEEE 802.1ad (also
known as Q-in-Q, double-tagging). But the switch should be able to forward the double-tagged frames. Some
switches will strip out the inner tag and Fortinet recommends avoiding these switches. FortiSwitch D and E series
can correctly forward double-tagged frames.

This configuration is not required for FortiGate-6000 HA configurations if you have set
up direct connections between the HA heartbeat interfaces.

This example shows how to configure a FortiGate-6000 to use different VLAN IDs for the HA1 and HA2 HA
heartbeat interfaces and then how to configure two ports on a Cisco switch to allow HA heartbeat packets.
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This example sets the native VLAN ID for both switch ports to 777. You can use any
VLAN ID as the native VLAN ID as long as the native VLAN ID is not the same as the
allowed VLAN ID.

1. On both FortiGate-6000s in the HA configuration, enter the following command to use different VLAN IDs for the
HA1 and HA2 interfaces. The command sets the ha1 VLAN ID to 4091 and the ha2 VLAN ID to 4092:
config system ha

set hbdev ha1 50 ha2 100
set hbdev-vlan-id 4091
set hbdev-second-vlan-id 4092

end
2. Use the get system ha status command to confirm the VLAN IDs.

get system ha status

...

HBDEV stats:

F6KF51T018900026(updated 4 seconds ago):

ha1: physical/10000full, up, rx-bytes/packets/dropped/errors=54995955/230020/0/0,

tx=63988049/225267/0/0, vlan-id=4091

ha2: physical/10000full, up, rx-bytes/packets/dropped/errors=54995955/230020/0/0,

tx=63988021/225267/0/0, vlan-id=4092

F6KF51T018900022(updated 3 seconds ago):

ha1: physical/10000full, up, rx-bytes/packets/dropped/errors=61237440/230023/0/0,

tx=57746989/225271/0/0, vlan-id=4091

ha2: physical/10000full, up, rx-bytes/packets/dropped/errors=61238907/230023/0/0,

tx=57746989/225271/0/0, vlan-id=4092

...

3. Configure the Cisco switch port that connects the HA1 interfaces to allow packets with a VLAN ID of 4091:
interface <name>

switchport mode trunk
switchport trunk native vlan 777
switchport trunk allowed vlan 4091

4. Configure the Cisco switch port that connects the HA2 interfaces to allow packets with a VLAN ID of 4092:
interface <name>

switchport mode trunk
switchport trunk native vlan 777
switchport trunk allowed vlan 4092

Basic FortiGate-6000 HA configuration
Use the following steps to set up HA between two FortiGate-6000s. To configure HA, you assign a chassis ID (1
and 2) to each of the FortiGate-6000s. These IDs allow the FGCP to identify the chassis and do not influence
primary FortiGate-7000 selection. Before you start, determine which FortiGate-6000 should be chassis 1 and
which should be chassis 2.

1. Set up HA heartbeat communication as described in Connect the HA1 and HA2 interfaces for HA heartbeat
communication on page 653.

2. Log into the GUI or CLI of the FortiGate-6000 that will become chassis 1.
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3. Use the following CLI command to change the host name. This step is optional, but setting a host name makes
the FortiGate-6000 easier to identify after the cluster has formed.
config system global

set hostname 6K-Chassis-1
end

From the GUI you can configure the host name by going to System > Settings and changing the
Host name.

4. Enter the following command to configure basic HA settings for the chassis 1 FortiGate-6000:
config system ha

set group-id 6
set group-name My-6K-cluster
set mode a-p
set hbdev ha1 50 ha2 100
set chassis-id 1
set hbdev-vlan-id 4091
set hbdev-second-vlan-id 4092
set password <password>

end

From the GUI you can configure HA by going to System > HA. Set theMode to Active-Passive, set the
Group Name, add a Password, and set the Heartbeat Interface Priority for the heartbeat interfaces (1-
M1, 1-M2, 2-M1, and 2-M2). You must configure the chassis ID and group ID from the CLI.

5. Log into the chassis 2 FortiGate-6000 and configure its host name, for example:
config system global

set hostname 6K-Chassis-2
end

From the GUI you can configure the host name by going to System > Settings and changing the
Host name.

6. Enter the following command to configure basic HA settings. The configuration must be the same as the chassis 1
configuration, except for the chassis ID.
config system ha

set group-id 6
set group-name My-6K-cluster
set mode a-p
set hbdev ha1 50 ha2 100
set chassis-id 2
set hbdev-vlan-id 4091
set hbdev-second-vlan-id 4092
set password <password>

end

From the GUI you can configure HA by going to System > HA. Set theMode to Active-Passive, set the
Group Name, add a Password, and set the Heartbeat Interface Priority for the heartbeat interfaces (1-
M1, 1-M2, 2-M1, and 2-M2). You must configure the chassis ID and group ID from the CLI.

Once you save your configuration changes, if the HA hearbeat interfaces are connected, the
FortiGate-6000s negotiate to establish a cluster. You may temporarily lose connectivity with the
FortiGate-6000s as the cluster negotiates and the FGCP changes the MAC addresses of the
FortiGate-6000 interfaces. To be able to reconnect sooner, you can update the ARP table of your
management PC by deleting the ARP table entry for the FortiGate (or just deleting all ARP table
entries). You may be able to delete the ARP table of your management PC from a command prompt
using a command similar to arp -d. When the cluster has completed negotiating, you can log into it
using the management IP address of the primary FortiGate-6000.
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7. Log into the cluster and view the HA Status dashboard widget or enter the get system ha status command
to confirm that the cluster has formed and is operating normally.
If the cluster is operating normally, you can connect network equipment, add your configuration, and start
operating the cluster.

Verifying that the cluster is operating normally

You view the cluster status from the HA Status dashboard widget or by using the get system ha status
command.

If the HA Status widget or the get system ha status command shows a cluster has not formed, check the
HA heartbeat connections. They should be configured as described in Connect the HA1 and HA2 interfaces for
HA heartbeat communication on page 653.

You should also review the HA configurations of the FortiGate-6000s. When checking the configurations, make
sure both FortiGate-6000s have the same HA configuration, including identical HA group IDs, group names,
passwords, and HA heartbeat VLAN IDs.

The following example FortiGate-6000 get system ha status output shows a FortiGate-6000 cluster that
is operating normally. The output shows which FortiGate-6000 has become the primary (master) FortiGate-6000
and how it was chosen. You can also see CPU and memory use data, HA heartbeat VLAN IDs, and so on.

get system ha status

Master selected using:

HA Health Status: OK

Model: FortiGate-6000F

Mode: HA A-P

Group: 6

Debug: 0

Cluster Uptime: 0 days 12:42:5

Cluster state change time: 2019-02-24 16:26:30

<2019/02/24 16:26:30> F6KF31T018900143 is selected as the master because it has the largest value of

serialno.

ses_pickup: disable

override: disable

Configuration Status:

F6KF31T018900143(updated 4 seconds ago): in-sync

F6KF51T018900022 (updated 0 seconds ago): in-sync

System Usage stats:

F6KF31T018900143(updated 4 seconds ago):

sessions=198, average-cpu-user/nice/system/idle=1%/0%/0%/97%, memory=5%

F6KF51T018900022 (updated 0 seconds ago):

sessions=0, average-cpu-user/nice/system/idle=2%/0%/0%/96%, memory=6%

HBDEV stats:

F6KF31T018900143(updated 4 seconds ago):

ha1: physical/10000full, up, rx-bytes/packets/dropped/errors=227791977/902055/0/0,

tx=85589814/300318/0/0, vlan-id=4091

ha2: physical/10000full, up, rx-bytes/packets/dropped/errors=227791977/902055/0/0,

tx=85589814/300318/0/0, vlan-id=4092

F6KF51T018900022(updated 0 seconds ago):

ha1: physical/10000full, up, rx-bytes/packets/dropped/errors=0/0/0/0, tx=85067/331/0/0, vlan-id=4091

ha2: physical/10000full, up, rx-bytes/packets/dropped/errors=947346/3022/0/0, tx=206768/804/0/0,
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vlan-id=4092

Master: 6K-Chassis-1 , F6KF31T018900143, cluster index = 0

Slave : 6K-Chassis-2    , F6KF51T018900022, cluster index = 1

number of vcluster: 1

vcluster 1: work 10.101.11.20

Master: F6KF31T018900143, operating cluster index = 0

Slave : F6KF51T018900022, operating cluster index = 1

Chassis Status: (Local chassis ID: 2)

Chassis ID 1: Slave Chassis

Slot ID 1: Master Slot

Slot ID 2: Slave Slot

Chassis ID 2: Master Chassis

Slot ID 1: Master Slot

Slot ID 2: Slave Slot

Managing individual management boards and FPCs in HA mode
In some cases, you may want to connect to an individual FPC in one of the FortiGate-6000s in the HA cluster. For
example, you may want to view the traffic being processed by the FPC in slot 3 of chassis 2. You can connect to
the GUI or CLI of individual FPCs in the FortiGate-6000 using the management IP address with a special port
number.

For example, if the management IP address is 1.1.1.1 you can browse to https://1.1.1.1:44323 to connect to the
FPC in chassis 2 slot 3. The special port number (in this case 44323) is a combination of the service port, chassis
ID, and slot number. The special port numbers are the same as those listed under Getting started with FortiGate-
6000 on page 619 with the addition of the number 2 for FPCs in the FortiGate-6000 with chassis ID 2.

For example:

l To connect to the GUI of the FPC in chassis 2 slot 6 using HTTPS you would browse to https://1.1.1.1:44326.

The formula for calculating the special port number is based on Chassis ID. CH1 =
Chassis ID1, CH2 = Chassis ID2. The formula is: service_port x 100 + (chassis_id – 1)
x 20 + slot_id.

Firmware upgrade
Both management boards and all of the FPCs in a FortiGate-6000 HA cluster run the same firmware image. You
upgrade the firmware from the GUI or CLI by logging into the primary FortiGate-6000 and installing the firmware
image.

If uninterruptable-upgrade and session-pickup are enabled, firmware upgrades should only cause a
minimal traffic interruption. Use the following command to enable these settings (they should be enabled by
default). These settings are synchronized.

config system ha
set uninterruptable-upgrade enable
set session-pickup enable

end

When these settings are enabled, the primary FortiGate-6000 management board uploads firmware to the
backup FortiGate-6000 management board. The backup management board uploads the firmware to all of the
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FPCs in the backup FortiGate-6000. Then the management board and all of the FPCs in the backup ForiGate-
6000 upgrade their firmware and reboot and resynchronize.

Then all traffic fails over to the backup FortiGate-6000 which becomes the new primary FortiGate-6000. Then the
management board and the FPCs in the new backup FortiGate-6000 upgrade their firmware and rejoin the
cluster. Unless override is enabled, the new primary FortiGate-6000 continues to operate as the primary
FortiGate-6000.

Normally you would want to enable uninterruptable-upgrade to minimize traffic interruptions. But
unterruptable-upgrade does not have to be enabled. In fact, if a traffic interruption is not going to cause
any problems you can disable unterruptable-upgrade so that the firmware upgrade process takes less
time.

Distributed clustering
FortiGate-6000 HA supports separating the FortiGate-6000s in different physical locations. Distributed FortiGate-
6000 HA clustering (or geographically distributed FortiGate-6000 HA or geo clustering) can involve two FortiGate-
6000s in different rooms in the same building, different buildings in the same location, or even different
geographical sites such as different cities, countries or continents.

Just like any FortiGate-6000 HA configuration, distributed FortiGate-6000 HA requires heartbeat communication
between the FortiGate-6000s over the HA1 and HA2 interfaces. In a distributed FortiGate-6000 HA configuration
this heartbeat communication can take place over the Internet or over other transmission methods including
satellite linkups.

Most Data Center Interconnect (DCI) or MPLS-based solutions that support layer 2 extensions and VLAN tags
between the remote data centers should also support HA heartbeat communication between the FortiGates in
the distributed locations. Using VLANs and switches in promiscuous mode to pass all traffic between the
locations can also be helpful.

You cannot change HA heartbeat IP addresses, so the heartbeat interfaces have to be able to communication
over the same subnet.

The HA1 and HA2 interface traffic must be separated. You can do this by using separate channels for each
interface or by configuring the HA1 and HA2 interfaces to use different VLANs.

658 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 5 - FortiGate-6000 FortiGate-6000 high availability (FGCP)

Example FortiGate-6000 distributed clustering configuration

Because of the possible distance between sites, it may take a relatively long time for heartbeat packets to be
transmitted between the FortiGate-6000s. This could lead to a split brain scenario. To avoid a split brain scenario
you can modify heartbeat timing so that the cluster expects extra time between heartbeat packets. As a general
rule, set the heartbeat failover time (hb-interval) to be longer than the max latency or round trip time (RTT).
You could also increase the hb-lost-threshold to tolerate losing heartbeat packets if the network
connection is less reliable.

In addition you could use different link paths for heartbeat packets to optimize HA heartbeat communication. You
could also configure QoS on the links used for HA heartbeat traffic to make sure heartbeat communication has
the highest priority.

Modifying heartbeat timing
If the FortiGate-6000s in the HA cluster do not receive heartbeat packets on time, the FortiGate-6000s in the HA
configuration may each determine that the other FortiGate-6000 has failed. HA heartbeat packets may not be
sent on time because of network issues. For example, if the HA1 and HA2 communications links between the
FortiGate-6000s become too busy to handle the heartbeat traffic. Also, in a distributed clustering configuration
the round trip time (RTT) between the FortiGate-6000s may be longer the expected time between heartbeat
packets.

In addition, if the FortiGate-6000s becomes excessively busy, they may delay sending heartbeat packets.
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Even with these delays, the FortiGate-6000 HA cluster can continue to function normally as long as the
HA heartbeat configuration supports longer delays between heartbeat packets and more missed heartbeat
packets.

You can use the following commands to configure heartbeat timing:

config system ha
set hb-interval <interval_integer>
set hb-lost-threshold <threshold_integer>
set hello-holddown <holddown_integer>

end

Changing the heartbeat interval

The heartbeat interval is the time between sending HA heartbeat packets. The heartbeat interval range is 1 to 20
(100*ms). The heartbeat interval default is 2 (200 ms).

A heartbeat interval of 2 means the time between heartbeat packets is 200 ms. Changing the heartbeat interval
to 5 changes the time between heartbeat packets to 500 ms (5 * 100ms = 500ms).

Use the following CLI command to increase the heartbeat interval to 10:

config system ha
set hb-interval 10

end

Changing the lost heartbeat threshold

The lost heartbeat threshold is the number of consecutive heartbeat packets that a FortiGate does not receive
before assuming that a failure has occurred. The default value of 6mean that if a FortiGate-6000 does not receive
6 heartbeat packets it determines that the other FortiGate-6000 in the cluster has failed. The range is 1 to 60
packets.

The lower the hb-lost-threshold, the faster a FortiGate-6000 HA configuration responds when a failure
occurs. However, sometimes heartbeat packets may not be received because the other FortiGate-6000 is very
busy or because of network conditions. This can lead to a false positive failure detection. To reduce these false
positives you can increase the hb-lost-threshold.

Use the following command to increase the lost heartbeat threshold to 12:

config system ha
set hb-lost-threshold 12

end

Adjusting the heartbeat interval and lost heartbeat threshold

The heartbeat interval combines with the lost heartbeat threshold to set how long a FortiGate-6000 waits before
assuming that the other FortiGate-6000 has failed and is no longer sending heartbeat packets. By default, if a
FortiGate-6000 does not receive a heartbeat packet from a cluster unit for 6 * 200 = 1200 milliseconds or 1.2
seconds the FortiGate-6000 assumes that the other FortiGate-6000 has failed.

You can increase both the heartbeat interval and the lost heartbeat threshold to reduce false positives. For
example, increasing the heartbeat interval to 20 and the lost heartbeat threshold to 30 means a failure will be
assumed if no heartbeat packets are received after 30 * 2000 milliseconds = 60,000 milliseconds, or 60 seconds.

Use the following command to increase the heartbeat interval to 20 and the lost heartbeat threshold to 30:

config system ha
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set hb-lost-threshold 20
set hb-interval 30

end

Changing the time to wait in the hello state

The hello state hold-down time is the number of seconds that a FortiGate-6000 waits before changing from hello
state to work state. After a failure or when starting up, FortiGate-6000s in HAmode operate in the hello state to
send and receive heartbeat packets to find each other and form a cluster. A FortiGate-6000 should change from
the hello state to work state after it finds the FortiGate-6000 to form a cluster with. If for some reason the
FortiGate-6000s cannot find each other during the hello state both FortiGate-6000s may assume that the other
one has failed and each could form separate clusters of one FortiGate-6000. The FortiGate-6000s could
eventually find each other and negotiate to form a cluster, possibly causing a network interruption as they re-
negotiate.

One reason for a delay of the FortiGate-6000s finding each other could be the FortiGate-6000s are located at
different sites or for some other reason communication is delayed between the heartbeat interfaces. If you find
that your FortiGate-6000s leave the hello state before finding each other you can increase the time that they wait
in the hello state. The hello state hold-down time range is 5 to 300 seconds. The hello state hold-down time
default is 20 seconds.

Use the following command to increase the time to wait in the hello state to 1 minute (60 seconds):

config system ha
set hello-holddown 60

end

Session failover (session-pickup)
Session failover means that after a failover, communication sessions resume on the new primary FortiGate-6000
with minimal or no interruption. Two categories of sessions need to be resumed after a failover:

l Sessions passing through the cluster
l Sessions terminated by the cluster

If sessions pickup is enabled, during cluster operation the primary FortiGate-6000 informs the backup FortiGate-
6000 of changes to the primary FortiGate-6000 connection and state tables for TCP and UDP sessions passing
through the cluster, keeping the backup FortiGate-6000 up-to-date with the traffic currently being processed by
the cluster.

After a failover, the new primary FortiGate-6000 recognizes open sessions that were being handled by the
cluster. The sessions continue to be processed by the new primary FortiGate-6000 and are handled according to
their last known state.

Session-pickup has some limitations. For example, the FGCP does not support
session failover for sessions being scanned by proxy-based security profiles. Session
failover is supported for sessions being scanned by flow-based security profiles;
however, flow-based sessions that fail over are not inspected after they fail over.

Sessions terminated by the cluster include management sessions (such as HTTPS connections to the FortiGate
GUI or SSH connection to the CLI as well as SNMP and logging, and so on). Also included in this category are
IPsec and SSL VPN sessions terminated by the cluster and explicit proxy sessions. In general, whether or not
session-pickup is enabled, these sessions do not failover and have to be restarted.
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Enabling session pickup for TCP and UDP sessions

To enable session-pickup, from the CLI enter:

config system ha
set session-pickup enable

end

When session-pickup is enabled, sessions in the primary FortiGate-6000 TCP and UDP session tables are
synchronized to the backup FortiGate-6000. As soon as a new TCP or UDP session is added to the primary
FortiGate-6000 session table, that session is synchronized to the backup FortiGate-6000. This synchronization
happens as quickly as possible to keep the session tables synchronized.

If the primary FortiGate-6000 fails, the new primary FortiGate-6000 uses its synchronized session tables to
resume all TCP and UDP sessions that were being processed by the former primary FortiGate-6000 with only
minimal interruption. Under ideal conditions all TCP and UDP sessions should be resumed. This is not
guaranteed though and under less than ideal conditions some sessions may need to be restarted.

If session pickup is disabled

If you disable session pickup, the FortiGate-6000 HA cluster does not keep track of sessions and after a failover,
active sessions have to be restarted or resumed. Most session can be resumed as a normal result of how TCP
and UDP resumes communication after any routine network interruption.

The session-pickup setting does not affect session failover for sessions terminated by
the cluster.

If you do not require session failover protection, leaving session pickup disabled may reduce CPU usage and
reduce HA heartbeat network bandwidth usage. Also, if your FortiGate-6000 HA cluster is mainly being used for
traffic that is not synchronized (for example, for proxy-based security profile processing) enabling session pickup
is not recommended since most sessions will not be failed over anyway.

FortiGate-6000 support for VRRP
The FortiGate-6000 platform supports the Virtual Router Redundancy Protocol (VRRP), allowing you to configure
VRRPHA between FortiGate-6000 devices. You can also add a FortiGate-6000 to a VRRP group with other
VRRP routers.

Configure VRRP on the FortiGate-6000 by creating a VRRP group and adding one or more front panel interfaces
to the group.

During normal operation, the primary FortiGate-6000 sends outgoing VRRP routing advertisements. Both the
primary and backup FortiGate-6000s listen for incoming VRRP advertisements from other routers in the VRRP
group. If the primary FortiGate-6000 fails, the new primary FortiGate-6000 takes over the role of both sending
and receiving VRRP advertisements, maintaining the FortiGate-6000 within the VRRP group.

FortiGate-6000 v5.6.7 special features and limitations

This section describes special features and limitations for FortiGate-6000 v5.6.7.
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Remote console limitations
Some console input may not function as expected. For example, when remotely connecting to an FPC console
using Telnet, when viewing the BIOSmenu, pressing the H key to display BIOS menu help does not always work
as expected.

Default management VDOM
By default the FortiGate-6000 configuration includes a management VDOM named mgmt-vdom. The ha1, ha2,
mgmt1, mgmt2, and mgmt3 interfaces are in mgmt-vdom and all other interfaces are in the root VDOM. For the
FortiGate-6000 system to operate normally, mgmt-vdom must always be the management VDOM. You also
must not remove interfaces from this VDOM. You can change the IP addresses of the interfaces in mgmt-vdom,
allow the required management services, and add routes as required for management traffic.

You have full control over the configurations of other FortiGate-6000 VDOMs.

Maximum number of LAGs
FortiGate-6000 systems support up to 16 link aggregation groups (LAGs). This includes both normal link
aggregation groups and redundant interfaces.

Firewall
TCP or UDP sessions with NAT enabled that are expected to be idle for more than the distributed processing
normal TCP timer (which is 3605 seconds) will timeout. If you encounter this problem you can use the following
command to increase the TCP timer:

config system global
set dp-tcp-normal-timer <timer>

end

IP Multicast
IPv4 and IPv6 Multicast traffic is only sent to the primary FPC. This is controlled by the following configuration:

config load-balance flow-rule
edit 15

set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 224.0.0.0 240.0.0.0
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv4 multicast"

next
edit 16

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
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set dst-addr-ipv6 ff00::/8
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv6 multicast"

end

High Availability
Only the HA1 and HA2 interfaces are used for the HA heartbeat communication. For information on how to set up
HA heartbeat communication using the HA1 and HA2 interfaces, see Connect the HA1 and HA2 interfaces for HA
heartbeat communication on page 653.

The following FortiOS HA features are not supported or are supported differently by FortiGate-6000 v5.6.7:

l Active-active HA is not supported.
l The range for the HA group-id is 0 to 31.
l Failover logic for FortiGate-6000 v5.6.7 HA is the same as FGCP for other FortiGate clusters.
l HA heartbeat configuration is specific to FortiGate-6000 systems and differs from standard HA.
l FortiGate Session Life Support Protocol (FGSP) HA (also called standalone session synchronization) is not

supported.

FortiOS features that are not supported by FortiGate-6000 v5.6.7
The following mainstream FortiOS 5.6.7 features are not supported by the FortiGate-6000 v5.6.7:

l SD-WAN (because of known issues)
l HA dedicated management interfaces
l Hardware switch
l Switch controller
l WiFi controller
l IPv4 over IPv6, IPv6 over IPv4, IPv6 over IPv6 features
l GRE tunneling is only supported after creating a load balance flow rule, for example:

config load-balance flow-rule
edit 0

set status enable
set vlan 0
set ether-type ip
set protocol gre
set action forward
set forward-slot master
set priority 3

end

l Only the FortiGate-6301F and the FortiGate-6501F support hard disk features such asWAN optimization, web
caching, explicit proxy content caching, disk logging, and GUI-based packet sniffing.

l The FortiGate-6000 platform, including the FortiGate-6301F and the FortiGate-6501F does not support
quarantining files to the internal hard disks. Instead you must set the quarantine function to quarantine files to
FortiAnalyzer.

l The management interfaces (mgmt1-3) do not support device detection for the networks they are connected to.
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IPsec VPN tunnels terminated by the FortiGate-6000
For a list of new FortiOS 5.6 FortiGate-6000 IPsec VPN features and a list of IPsec VPN features not supported
by FortiOS 5.6 FortiGate-6000 IPsec VPN, see New IPsec VPN features on page 645.

SSL VPN
Sending all SSL VPN sessions to the primary (master) FPC is recommended. You can do this by:

l Creating a flow rule that sends all sessions that use the SSL VPN destination port and IP address to the primary
FPC.

l Creating flow rules that send all sessions that use the SSL VPN IP pool addresses to the primary FPC.

Traffic shaping
You can only configure traffic shaping from the CLI. Each FPC applies traffic shaping quotas independently.
Traffic is first load balanced to the FPCs and then traffic shaping is applied by the FPC to the traffic load balanced
to it.This may result in traffic shaping allowing more traffic than expected.

DDoS quotas
Each FPC applies DDoS quotas independently. Traffic is first load balanced to the FPCs and then DDoS quotas
are applied by the FPC to the traffic load balanced to it. This may result in DDoS quotas being less effective than
expected.

Sniffer mode (one-arm sniffer)
One-arm sniffer mode is only supported after creating a load balance flow rule to direct sniffer traffic to a specific
FPC.

FortiGuard Web filtering and Spam filtering
The FortiGate-6000 sends all FortiGuard web filtering and spam filtering rating queries through a management
interface from the management VDOM.

Log messages include a slot field
An additional "slot" field has been added to log messages to identify the FPC that generated the log.

Special notice for new deployment connectivity testing
Only the management board can successfully ping external IP addresses. During a new deployment, while
performing connectivity testing from the Fortigate-6000, make sure to run execute ping tests from the
management board and not from an FPC. See Using data interfaces for management traffic on page 622 for
information about changes to this limitation.
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Dedicated management interfaces not supported
The FortiGate-6000 does not support configuring dedicated management interfaces using the config system
dedicated-mgmt command. Instead you can enter the following to configure an interface to be dedicated to
management:

config system interface
edit <interface-name>

set dedicated-to management
end

FortiGate-6000 v5.6.6 special features and limitations

This section describes special features and limitations for FortiGate-6000 v5.6.6.

Remote console limitations
Some console input may not function as expected. For example, when remotely connecting to an FPC console
using Telnet, when viewing the BIOSmenu, pressing the H key to display BIOS menu help does not always work
as expected.

Default management VDOM
By default the FortiGate-6000 configuration includes a management VDOM named mgmt-vdom.The ha1, ha2,
mgmt1, mgmt2, and mgmt3 interfaces are in mgmt-vdom and all other interfaces are in the root VDOM. For the
FortiGate-6000 system to operate normally, mgmt-vdom must always be the management VDOM. You also
must not remove interfaces from this VDOM. You can change the IP addresses of the interfaces in mgmt-vdom,
allow the required management services, and add routes as required for management traffic.

You have full control over the configurations of other FortiGate-6000 VDOMs.

Maximum number of LAGs
FortiGate-6000 systems support up to 16 link aggregation groups (LAGs). This includes both normal link
aggregation groups and redundant interfaces.

Firewall
TCP or UDP sessions with NAT enabled that are expected to be idle for more than the distributed processing
normal TCP timer (which is 3605 seconds) will timeout. If you encounter this problem you can use the following
command to increase the TCP timer:

config system global
set dp-tcp-normal-timer <timer>

end

IP Multicast
IPv4 and IPv6 Multicast traffic is only sent to the primary FPC. This is controlled by the following configuration:
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config load-balance flow-rule
edit 15

set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 224.0.0.0 240.0.0.0
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv4 multicast"

next
edit 16

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ff00::/8
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv6 multicast"

end

High Availability
Only the HA1 and HA2 interfaces are used for the HA heartbeat communication. For information on how to set up
HA heartbeat communication using the HA1 and HA2 interfaces, see Connect the HA1 and HA2 interfaces for HA
heartbeat communication on page 653.

The following FortiOS HA features are not supported or are supported differently by FortiGate-6000 v5.6.6:

l Active-active HA is not supported.
l The range for the HA group-id is 0 to 15.
l Failover logic for FortiGate-6000 v5.6.6 HA is the same as FGCP for other FortiGate clusters.
l HA heartbeat configuration is specific to FortiGate-6000 systems and differs from standard HA.
l FortiGate Session Life Support Protocol (FGSP) HA (also called standalone session synchronization) is not

supported.

FortiOS features that are not supported by FortiGate-6000 v5.6.6
The following mainstream FortiOS 5.6.6 features are not supported by the FortiGate-6000 v5.6.6:

l SD-WAN (because of known issues)
l Policy learning mode
l HA dedicated management interfaces
l Hardware switch
l Switch controller
l WiFi controller
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l IPv4 over IPv6, IPv6 over IPv4, IPv6 over IPv6 features
l GRE tunneling is only supported after creating a load balance flow rule, for example:

config load-balance flow-rule
edit 0

set status enable
set vlan 0
set ether-type ip
set protocol gre
set action forward
set forward-slot master
set priority 3

end

l Only the FortiGate-6301F and the FortiGate-6501F support hard disk features such asWAN optimization, web
caching, explicit proxy content caching, disk logging, and GUI-based packet sniffing.

l The FortiGate-6000 platform, including the FortiGate-6301F and the FortiGate-6501F does not support
quarantining files to the internal hard disks. Instead you must set the quarantine function to quarantine files to
FortiAnalyzer.

l The management interfaces (mgmt1-3) do not support device detection for the networks they are connected to.

IPsec VPN tunnels terminated by the FortiGate-6000
For a list of new FortiOS 5.6.6 FortiGate-6000 IPsec VPN features and a list of IPsec VPN features not supported
by FortiOS 5.6.6 FortiGate-6000 IPsec VPN, see New IPsec VPN features on page 645.

SSL VPN
Sending all SSL VPN sessions to the primary (master) FPC is recommended. You can do this by:

l Creating a flow rule that sends all sessions that use the SSL VPN destination port and IP address to the primary
FPC.

l Creating flow rules that send all sessions that use the SSL VPN IP pool addresses to the primary FPC.

Traffic shaping
You can only configure traffic shaping from the CLI. Each FPC applies traffic shaping quotas independently.
Traffic is first load balanced to the FPCs and then traffic shaping is applied by the FPC to the traffic load balanced
to it.This may result in traffic shaping allowing more traffic than expected.

DDoS quotas
Each FPC applies DDoS quotas independently. Traffic is first load balanced to the FPCs and then DDoS quotas
are applied by the FPC to the traffic load balanced to it. This may result in DDoS quotas being less effective than
expected.

Sniffer mode (one-arm sniffer)
One-arm sniffer mode is only supported after creating a load balance flow rule to direct sniffer traffic to a specific
FPC.
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FortiGuard Web filtering and Spam filtering
The FortiGate-6000 sends all FortiGuard web filtering and spam filtering rating queries through a management
interface from the management VDOM.

Log messages include a slot field
An additional "slot" field has been added to log messages to identify the FPC that generated the log.

Special notice for new deployment connectivity testing
Only the management board can successfully ping external IP addresses. During a new deployment, while
performing connectivity testing from the Fortigate-6000, make sure to run execute ping tests from the
management board and not from an FPC. See Using data interfaces for management traffic on page 622 for
information about changes to this limitation.

Dedicated management interfaces not supported
The FortiGate-6000 does not support configuring dedicated management interfaces using the config system
dedicated-mgmt command. Instead you can enter the following to configure an interface to be dedicated to
management:

config system interface
edit <interface-name>

set dedicated-to management
end
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See the FortiOS 5.6 CLI Reference for information about FortiGate-6000 CLI commands:

l config load-balance flow-rule
l config load-balance setting
l execute load-balance
l execute system console-server
l execute reset-vd-license
l execute log filter confsync-member
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Chapter 6 - FortiGate-7000

What's new for FortiGate-7000 v5.6.7

The following new features have been added to FortiGate-7000 v5.6.7 build 4214:

l Policy learning mode is now supported.
l The FortiGate-7000 supports 64000 explicit proxy web proxy users.
l The HA group ID range is now from 0 to 31 (was 0 to 15).

671 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



What's new for FortiGate-7000 5.6.6

Version 5.6.6 enhancements include adding FortiOS 5.6.6 to the FortiGate-7000 platform. This release also
includes bug fixes and improvements and the following new features.

l Support for FortiOS 5.6.6 and most 5.6.6 features including FortiOS 5.6.6 GUI features.
l You can configure new Resource Usage dashboard widgets to show CPU use, log rate, memory use, session

creation rate, and the number of active sessions for individual FIMs, the management plane, the data plan and the
security fabric.

l The Security Fabric dashboard widget shows high level status and configuration information for all of the FPMs.
l The Sensor Information dashboard widget displays temperature information and allows you to drill down for

information about individual temperature sensors.
l DP2 firmware upgrade
l VRRP support. For a list of know VRRP issues, see VRRP known issues on page 1.
l The management VDOM is now named mgmt-vdom (was dmgmt-vdom).
l The diagnose sniffer packet command now shows the name of the FPM that processed the packet.
l You can now use the execute ping and execute traceroute commands from an FIM CLI to an external

destination.
l FIMs directly query LDAP/FSSO/RADIUS servers. These queries no longer have to go through the management

VDOM.
l The Route Monitor displays accurate routing information.
l SNMP integration improvements including new MIBs.

l The following FortiOS 5.6.6 features are not supported:
l SD-WAN
l Some IPsec VPN features
l Policy learning mode
l HA dedicated management interfaces

New IPsec VPN features

FortiOS 5.6.6 includes the following IPsec VPN improvements:

l Including a phase 2 selector is no longer mandatory.
l Dynamic routing (RIP, OSPF, BGP) is supported over IPsec VPN tunnels.

IPsec VPN features supported by FortiOS 5.6.6 for FortiGate-7000

FortiOS 5.6.6 for FortiGate-7000 supports the following IPsec VPN features.

l Interface-based IPsec VPN (also called route-based IPsec VPN).
l Static routes can point IPsec VPN interfaces.
l Dynamic routing (RIP, OSPF, BGP) over IPsec VPN tunnels.
l Remote networks with 16- to 32-bit netmasks.
l IPsec VPN tunnels must terminate on the primary FPM (the ELBCmaster).
l Site-to-Site IPsec VPN.
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l Dialup IPsec VPN. The FortiGate-7000 can be the dialup server or client.
l IPv4 clear-text traffic (IPv4 over IPv4 or IPv4 over IPv6)

IPsec VPN features not supported by FortiOS 5.6.6 for FortiGate-7000

FortiOS 5.6.6 for FortiGate-7000 does not support the following IPsec VPN features.

l Policy-based IPsec VPN.
l Policy routes for VPN traffic.
l Remote networks with 0- to 15-bit netmasks.
l IPv6 clear-text traffic (IPv6 over IPv4 or IPv6 over IPv6).
l Load-balancing IPsec VPN tunnels to multiple FPMs.
l IPsec SA synchronization between both FortiGate-7000s in an HA configuration.

New High Availability features and changes

Configuring FortiGate-7000 HA has been simplified for FortiOS 5.6.6. To set up HA, you no longer have to
configure HA settings for both of the FIMs in a FortiGate-7000. Instead, you configure HA settings on the primary
FIM and this configuration is synchronized to the other FIM.

As well, FortiGate-7000 HA is configured and operates more like standard FGCPHA. The link failure threshold
concept that was part of FortiGate-7000 for FortiOS 5.4 has been removed and board failover tolerance has been
simplified. As well, primary unit selection has been simplified to be more like FGCP primary unit selection.

FortiOS 5.6.6 also includes the following new features and changes:

l The System > HA GUI page now appears and can be used to configure most HA settings.
l You can configure HA interface monitoring (or port monitoring) to detect link failures.
l You can configure HA remote link failover (also called remote IPmonitoring) to detect remote link failures using the

following options:
l Enable remote IPmonitoring with the pingserver-monitor-interface option.
l Set the remote IPmonitoring failover threshold with the pingserver-failover-threshold option.
l Force the cluster to negotiate after a remote IPmonitoring failover with the pingserver-slave-
force-reset option.

l Adjust the time to wait in minutes before renegotiating after a remote IPmonitoring failover with the
pingserver-flip-timeout option.

l You can use the get system ha status command to display HA status. The diagnose sys ha status
command is no longer available.

l The diagnose sys ha force-slave-state command is no longer available. To force the primary
FortGate-7000 into a backup (or slave) state you can use the diagnose sys ha reset-uptime command.

l The HA link-failure-threshold option has been removed.
l The board-failover-tolerance option has been simplified and determines how the cluster responds to

failed FIMs.
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A FortiGate-7000 product consists of a FortiGate-7000 series chassis (for example, the FortiGate-7040E) with
FortiGate-7000 modules installed in the chassis slots. A FortiGate-7040E chassis comes with two interface
modules (FIM) to be installed in slots 1 and 2 to provide network connections and session-aware load balancing
to two processor modules (FPM) to be installed in slots 3 and 4.

FortiGate-7000 products are sold and licensed as packages that include the chassis as well as the modules to be
included in the chassis. When you receive your FortiGate-7000 series product the chassis has to be installed in a
rack and the modules installed in the chassis. Interface modules always go in slots 1 and 2 and processor
modules in slots 3 and up.

If your FortiGate-7000 product includes two different interfaces modules, for optimal configuration you should
install the module with the lower model number in slot 1 and the module with the higher model number in slot 2.
For example, if your chassis includes a FIM-7901E and a FIM-7904E, install the FIM-7901E in chassis slot 1 and
the FIM-7904E in chassis slot 2. This applies to any combination of two different interface modules.

As an administrator, when you browse to the FortiGate-7000 management IP address you log into the interface
module in slot 1 (the primary or master interface module or FIM) to view the status of the FortiGate-7000 and
make configuration changes. The FortiOS firmware running on each module has the same configuration and
when you make configuration changes to the primary interface module, the configuration changes are
synchronized to all modules.

The same FortiOS firmware build runs on each module in the chassis. You can upgrade FortiGate-7000 firmware
by logging into the primary interface module and performing a firmware upgrade as you would for any FortiGate.
During the upgrade process the firmware of all of the modules in the chassis upgrades in one step. Firmware
upgrades should be done during a quiet time because traffic will briefly be interrupted during the upgrade
process.

Licenses, device registration, and support
A FortiGate-7000 product is made up of a FortiGate-7000 series chassis, one or two FIM interface modules and
two to four FPM processor modules. The entire package is licensed and configured as a single product under the
FortiGate-7000 chassis serial number. When you receive a new FortiGate-7000 product you register it on
https://support.fortinet.com using the chassis serial number. Use the chassis serial number when requesting
support from Fortinet for the product.

All Fortinet licensing, including FortiCare Support, IPS, AntiVirus, Web Filtering, Mobile Malware, FortiClient,
FortiCloud, and additional virtual domains (VDOM) is for the entire FortiGate-7000 product and not for individual
components.

If an individual component, such as a single interface or processor fails you can RMA and replace just that
component.

FortiGate-7060E
The FortiGate-7060E is a 8U 19-inch rackmount 6-slot chassis with a 80Gbps fabric and 1Gbps base backplane
designed by Fortinet. The fabric backplane provides network data communication and the base backplane
provides management and synch communication among the chassis slots.
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FortiGate-7060E front panel
The chassis is managed by two redundant management modules. Each module includes an Ethernet connection
as well as two switchable console ports that provide console connections to the modules in the chassis slots. The
active management module controls chassis cooling and power management and provides an interface for
managing the modules installed in the chassis.

FortiGate-7060E front panel, (example module configuration)

Power is provided to the chassis using four hot swappable 3+1 redundant 100-240 VAC, 50-60 Hz power supply
units (PSUs). You can also optionally add up to six PSUs to provide 3+3 redundancy. The FortiGate-7060E can
also be equipped with DC PSUs allowing you to connect the chassis to -48V DC power

The standard configuration of the FortiGate-7060E includes two FIM (interface) modules in chassis slots 1 and 2
and up to four FPM (processing) modules in chassis slots 3 to 6.

FortiGate-7060E schematic
The FortiGate-7060E chassis schematic below shows the communication channels between chassis components
including the management modules (MGMT), the FIMs (called FIM1 and FIM2) and the FPMs (FPM3, FPM4,
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FPM5, and FPM6).

By default, MGMT2 is the active management module and MGMT1 is inactive. The active management module
always has the Intelligent Platform Management Bus (IPMB) address 0x20 and the inactive management module
always has the IPMB address 0x22.

The active management module communicates with all modules in the chassis over the base backplane. Each
module, including the management modules has a Shelf Management Controller (SMC). These SMCs support
IPMB communication between the active management module and the FIM and FPMs for storing and sharing
sensor data that the management module uses to control chassis cooling and power distribution. The base
backplane also supports serial communications to allow console access from the management module to all
modules, and 1Gbps Ethernet communication for management and heartbeat communication between modules.

FIM1 and FIM2 (IPMB addresses 0x82 and 0x84) are the FIMs in slots 1 and 2. The interfaces of these modules
connect the chassis to data networks and can be used for Ethernet management access to chassis components.
The FIMs include DP2 processors that distribute sessions over the Integrated Switch Fabric (ISF) to the NP6
processors in the FPMs. Data sessions are communicated to the FPMs over the 80Gbps chassis fabric
backplane.

FPM03, FPM04, FPM05, and FPM06 (IPMB addresses 0x86, 0x88, 0x8A, and 0x8C) are the FPM processor
modules in slots 3 to 6. These worker modules process sessions distributed to them by the FIMs. FPMs include
NP6 processors to offload sessions from the FPM CPU and CP9 processors that accelerate content processing.

FortiGate-7040E
The FortiGate-7040E is a 6U 19-inch rackmount 4-slot chassis with a 80Gbps fabric and 1Gbps base backplane
designed by Fortinet. The fabric backplane provides network data communication and the base backplane
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provides management and synch communication among the chassis slots.

FortiGate-7040E front panel

The FortiGate-7040E chassis is managed by a single management module that includes an Ethernet connection
as well as two switchable console ports that provide console connections to the modules in the chassis slots. The
management module controls chassis cooling and power management and provides an interface for managing
the modules installed in the chassis. The standard configuration of the FortiGate-7040E includes two FIM
(interface) modules in chassis slots 1 and 2 and two FPM (processing) modules in chassis slots 3 and 4.

FortiGate-7040E front panel

FortiGate-7040E schematic

The FortiGate-7040E chassis schematic below shows the communication channels between chassis components
including the management module (MGMT), the FIMs (called FIM1 and FIM2) and the FPMs (FPM3 and FPM4).

677 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 6 - FortiGate-7000 FortiGate-7000 overview

The management module (MGMT, with Intelligent Platform Management Bus (IPMB) address 0x20)
communicates with all modules in the chassis over the base backplane. Each module, including the management
module, includes a Shelf Management Controller (SMC). These SMCs support IPMB communication between
the management module and the FIM and FPMs for storing and sharing sensor data that the management
module uses to control chassis cooling and power distribution. The base backplane also supports serial
communications to allow console access from the management module to all modules, and 1Gbps Ethernet
communication for management and heartbeat communication between modules.

FIM1 and FIM2 (IPMB addresses 0x82 and 0x84) are the FIMs in slots 1 and 2. The interfaces of these modules
connect the chassis to data networks and can be used for Ethernet management access to chassis components.
The FIMs include DP2 processors that distribute sessions over the Integrated Switch Fabric (ISF) to the NP6
processors in the FPMs. Data sessions are communicated to the FPMs over the 80Gbps chassis fabric
backplane.

FPM3 and FPM4 (IPMB addresses 0x86 and 0x88) are the FPM processor modules in slots 3 and 4. These
worker modules process sessions distributed to them by the FIMs. FPMs include NP6 processors to offload
sessions from the FPM CPU and CP9 processors that accelerate content processing.

FortiGate-7030E
The FortiGate-7030E is a 6U 19-inch rackmount 3-slot chassis with a 80Gbps fabric and 1Gbps base backplane
designed by Fortinet. The fabric backplane provides network data communication and the base backplane
provides management and synch communication among the chassis slots.

FortiGate-7030E front panel

The FortiGate-7030E chassis is managed by a single management module that includes an Ethernet connection
as well as two switchable console ports that provide console connections to the modules in the chassis slots. The
management module controls chassis cooling and power management and provides an interface for managing
the modules installed in the chassis. The standard configuration of the FortiGate-7030E includes one FIM
(interface) module in chassis slot 1 and two FPM (processing) modules in chassis slots 3 and 4. The front panel
also includes a sealed blank panel. Breaking the seal or removing the panel voids your FortiGate-7030E warranty.
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FortiGate-7030E front panel (example module configuration)

FortiGate-7030E schematic

The FortiGate-7030E chassis schematic below shows the communication channels between chassis components
including the management module (MGMT), the FIM (called FIM1) and the FPMs (FPM3 and FPM4).

The management module (MGMT, with Intelligent Platform Management Bus (IPMB) address 0x20)
communicates with all modules in the chassis over the base backplane. Each module, including the management
module includes a Shelf Management Controller (SMC). These SMCs support IPMB communication between the
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management module and the FIM and FPMs for storing and sharing sensor data that the management module
uses to control chassis cooling and power distribution. The base backplane also supports serial communications
to allow console access from the management module to all modules, and 1Gbps Ethernet communication for
management and heartbeat communication between modules.

FIM1 (IPMB address 0x82) is the FIM in slot 1. The interfaces of this module connect the chassis to data
networks and can be used for Ethernet management access to chassis components. The FIM includes DP2
processors that distribute sessions over the Integrated Switch Fabric (ISF) to the NP6 processors in the FPMs.
Data sessions are communicated to the FPMs over the 80Gbps chassis fabric backplane.

FPM3 and FPM4 (IPMB addresses 0x86 and 0x88) are the FPM processor modules in slots 3 and 4. These
worker modules process sessions distributed to them by the FIM. FPMs include NP6 processors to offload
sessions from the FPM CPU and CP9 processors that accelerate content processing.

FIM-7901E interface module
The FIM-7901E interface module is a hot swappable module that provides data, management and session
sync/heartbeat interfaces, base backplane switching and fabric backplane session-aware load balancing for a
FortiGate-7000 chassis. The FIM-7901E includes an integrated switch fabric and DP2 processors to load balance
millions of data sessions over the chassis fabric backplane to FPM processor modules.

The FIM-7901E can be installed in any FortiGate-7000 series chassis in hub/switch slots 1 and 2. The FIM-7901E
provides thirty-two 10GigE small form-factor pluggable plus (SPF+) interfaces for a FortiGate-7000 chassis.

You can also install FIM-7901Es in a second chassis and operate the chassis in HAmode with another set of
processor modules to provide chassis failover protection.

FIM-7901E front panel

The FIM-7901E includes the following hardware features:

l Thirty-two front panel 10GigE SFP+ fabric channel interfaces (A1 to A32). These interfaces are connected to
10Gbps networks to distribute sessions to the FPM processor modules installed in chassis slots 3 and up. These
interfaces can also be configured to operate as Gigabit Ethernet interfaces using SFP transceivers. These
interfaces also support creating link aggregation groups (LAGs) that can include interfaces from both FIM-7901Es.

l Two front panel 10GigE SFP+ interfaces (M1 and M2) that connect to the base backplane channel. These
interfaces are used for heartbeat, session sync, and management communication between FIM-7901Es in different
chassis. These interfaces can also be configured to operate as Gigabit Ethernet interfaces using SFP transceivers,
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but should not normally be changed. If you use switches to connect these interfaces, the switch ports should be
able to accept packets with a maximum frame size of at least 1526. The M1 and M2 interfaces need to be on
different broadcast domains. If M1 and M2 are connected to the same switch, Q-in-Q must be enabled on the
switch.

l Four 10/100/1000BASE-T out of band management Ethernet interfaces (MGMT1 to MGMT4).
l One 80Gbps fabric backplane channel for traffic distribution with each FPM installed in the same chassis as the

FIM-7901E.
l One 1Gbps base backplane channel for base backplane with each FPM installed in the same chassis as the FIM-

7901E.
l One 40Gbps fabric backplane channel for fabric backplane communication with the other FIM-7901E in the chassis.
l One 1Gbps base backplane channel for base backplane communication with the other FIM-7901E in the chassis.
l On-board DP2 processors and an integrated switch fabric to provide high-capacity session-aware load balancing.
l One front panel USB port.
l Power button.
l NMI switch (for troubleshooting as recommended by Fortinet Support).
l Mounting hardware.
l LED status indicators.

FIM-7901E schematic

The FIM-7901E includes an integrated switch fabric (ISF) that connects the FIM front panel interfaces to the DP2
session-aware load balancers and to the chassis fabric and base backplanes. The ISF also allows the DP2
processors to distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the
FortiGate-7000 chassis.

FIM-7901E schematic
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FIM-7904E interface module
The FIM-7904E interface module is a hot swappable module that provides data, management and session
sync/heartbeat interfaces, base backplane switching and fabric backplane session-aware load balancing for a
FortiGate-7000 series chassis. The FIM-7904E includes an integrated switch fabric and DP2 processors to load
balance millions of data sessions over the chassis fabric backplane to FPM processor modules.

The FIM-7904E can be installed in any FortiGate-7000 series chassis in hub/switch slots 1 and 2. The FIM-7904E
provides four Quad Small Form-factor Pluggable plus (QSFP+) interfaces for a FortiGate-7000 chassis. Using a
40GBASE-SR10 multimode QSFP+ transceiver, each QSFP+ interface can also be split into four 10GBASE-SR
interfaces.

You can also install FIM-7904Es in a second chassis and operate the chassis in HAmode with another set of
processor modules to provide chassis failover protection.

FIM-7904E front panel

The FIM-7904E includes the following hardware features:

l Eight front panel 40GigEQSFP+ fabric channel interfaces (B1 to B8). These interfaces are connected to 40Gbps
networks to distribute sessions to the FPM processor modules installed in chassis slots 3 and up. Using 40GBASE-
SR10 multimode QSFP+ transceivers, each QSFP+ interface can also be split into four 10GBASE-SR interfaces.
These interfaces also support creating link aggregation groups (LAGs) that can include interfaces from both FIM-
7904Es.

l Two front panel 10GigE SFP+ interfaces (M1 and M2) that connect to the base backplane channel. These
interfaces are used for heartbeat, session sync, and management communication between FIM-7904Es in different
chassis. These interfaces can also be configured to operate as Gigabit Ethernet interfaces using SFP transceivers,
but should not normally be changed. If you use switches to connect these interfaces, the switch ports should be
able to accept packets with a maximum frame size of at least 1526. The M1 and M2 interfaces need to be on
different broadcast domains. If M1 and M2 are connected to the same switch, Q-in-Q must be enabled on the
switch.

l Four 10/100/10000BASE-T out of band management Ethernet interfaces (MGMT1 to MGMT4).
l One 80Gbps fabric backplane channel for traffic distribution with each FPM installed in the same chassis as the

FIM-7904E.
l One 1Gbps base backplane channel for base backplane with each FPM installed in the same chassis as the FIM-

7904E.
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l One 40Gbps fabric backplane channel for fabric backplane communication with the other FIM-7904E in the chassis.
l One 1Gbps base backplane channel for base backplane communication with the other FIM-7904E in the chassis.
l On-board DP2 processors and an integrated switch fabric to provide high-capacity session-aware load balancing.
l One front panel USB port.
l Power button.
l NMI switch (for troubleshooting as recommended by Fortinet Support).
l Mounting hardware.
l LED status indicators.

Splitting the FIM-7904E B1 to B8 interfaces

Each 40GE interface (B1 to B8) on the FIM-7904Es in slot 1 and slot 2 of a FortiGate-7000 system can be split
into 4x10GBE interfaces. You split these interfaces after the FIM-7904Es are installed in your FortiGate-7000
system and the system us up and running. You can split the interfaces of the FIM-7904Es in slot 1 and slot 2 at
the same time by entering a single CLI command. Splitting the interfaces requires a system reboot so Fortinet
recommends that you split multiple interfaces at the same time according to your requirements to avoid traffic
disruption.

For example, to split the B1 interface of the FIM-7904E in slot 1 (this interface is named 1-B1) and the B1 and B4
interfaces of the FIM-7904E in slot 2 (these interfaces are named 2-B1 and 2-B4) connect to the CLI of your
FortiGate-7000 system using the management IP and enter the following command:

config system global
set split-port 1-B1 2-B1 2-B4

end

After you enter the command, the FortiGate-7000 reboots and when it comes up:

l The 1-B1 interface will no longer be available. Instead the 1-B1/1, 1-B1/2, 1-B1/3, and 1-B1/4 interfaces will be
available.

l The 2-B1 interface will no longer be available. Instead the 2-B1/1, 2-B1/2, 2-B1/3, and 2-B1/4 interfaces will be
available.

l The 2-B4 interface will no longer be available. Instead the 2-B4/1, 2-B4/2, 2-B4/3, and 2-B4/4 interfaces will be
available.

You can now connect breakout cables to these interfaces and configure traffic between them just like any other
FortiGate interface.

FIM-7904E hardware schematic

The FIM-7904E includes an integrated switch fabric (ISF) that connects the front panel interfaces to the DP2
session-aware load balancers and to the chassis backplanes. The ISF also allows the DP2 processors to
distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the FortiGate-7000
chassis.

683 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 6 - FortiGate-7000 FortiGate-7000 overview

FIM-7904E hardware architecture

FIM-7910E interface module
The FIM-7910E interface module is a hot swappable module that provides data, management and session
sync/heartbeat interfaces, base backplane switching and fabric backplane session-aware load balancing for a
FortiGate-7000 series chassis. The FIM-7910E includes an integrated switch fabric and DP2 processors to load
balance millions of data sessions over the chassis fabric backplane to FPM processor modules.

The FIM-7910E can be installed in any FortiGate-7000 series chassis in hub/switch slots 1 and 2. The FIM-7910E
provides four C form-factor pluggable 2 (CFP2) interfaces for a FortiGate-7000 chassis. Using a 100GBASE-
SR10 multimode CFP2 transceiver, each CFP2 interface can also be split into ten 10GBASE-SR interfaces.

FIM-7910E front panel

The FIM-7910E includes the following hardware features:
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l Four front panel 100GigE CFP2 fabric channel interfaces (C1 to C4). These interfaces are connected to 100Gbps
networks to distribute sessions to the FPM processor modules installed in chassis slots 3 and up. Using 100GBASE-
SR10 multimode CFP2 transceivers, each CFP2 interface can also be split into ten 10GBASE-SR interfaces. These
interfaces also support creating link aggregation groups (LAGs) that can include interfaces from both FIM-7910Es.

l Two front panel 10GigE SFP+ interfaces (M1 and M2) that connect to the base backplane channel. These
interfaces are used for heartbeat, session sync, and management communication between FIM-7910Es in different
chassis. These interfaces can also be configured to operate as Gigabit Ethernet interfaces using SFP transceivers,
but should not normally be changed. If you use switches to connect these interfaces, the switch ports should be
able to accept packets with a maximum frame size of at least 1526. The M1 and M2 interfaces need to be on
different broadcast domains. If M1 and M2 are connected to the same switch, Q-in-Q must be enabled on the
switch.

l Four 10/100/1000BASE-T out of band management Ethernet interfaces (MGMT1 to MGMT4).
l One 80Gbps fabric backplane channel for traffic distribution with each FPM installed in the same chassis as the

FIM-7910E.
l One 1Gbps base backplane channel for base backplane with each FPM installed in the same chassis as the FIM-

7910E.
l One 40Gbps fabric backplane channel for fabric backplane communication with the other FIM-7910E in the chassis.
l One 1Gbps base backplane channel for base backplane communication with the other FIM-7910E in the chassis.
l On-board DP2 processors and an integrated switch fabric to provide high-capacity session-aware load balancing.
l One front panel USB port.
l Power button.
l NMI switch (for troubleshooting as recommended by Fortinet Support).
l Mounting hardware.
l LED status indicators.

Splitting the FIM-7910E C1 to C4 interfaces

Each 100GE interface (C1 to C4) on the FIM-7910Es in slot 1 and slot 2 of a FortiGate-7000 system can be split
into 10 x 10GBE interfaces. You split these interfaces after the FIM-7910Es are installed in your FortiGate-7000
system and the system us up and running. You can split the interfaces of the FIM-7910Es in slot 1 and slot 2 at
the same time by entering a single CLI command. Splitting the interfaces requires a system reboot so Fortinet
recommends that you split multiple interfaces at the same time according to your requirements to avoid traffic
disruption.

For example, to split the C1 interface of the FIM-7910E in slot 1 (this interface is named 1-C1) and the C1 and C4
interfaces of the FIM-7910E in slot 2 (these interfaces are named 2-C1 and 2-C4) connect to the CLI of your
FortiGate-7000 system using the management IP and enter the following command:

config system global
set split-port 1-C1 2-C1 2-C4

end

After you enter the command, the FortiGate-7000 reboots and when it comes up:

l The 1-C1 interface will no longer be available. Instead the 1-C1/1, 1-C1/2, ..., and 1-C1/10 interfaces will be
available.

l The 2-C1 interface will no longer be available. Instead the 2-C1/1, 2-C1/2, ..., and 2-C1/10 interfaces will be
available.

l The 2-C4 interface will no longer be available. Instead the 2-C4/1, 2-C4/2, ..., and 2-C4/10 interfaces will be
available.
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You can now connect breakout cables to these interfaces and configure traffic between them just like any other
FortiGate interface.

FIM-7910E hardware schematic

The FIM-7910E includes an integrated switch fabric (ISF) that connects the front panel interfaces to the DP2
session-aware load balancers and to the chassis backplanes. The ISF also allows the DP2 processors to
distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the FortiGate-
7000chassis.

FIM-7910E hardware schematic

FIM-7920E interface module
The FIM-7920E interface module is a hot swappable module that provides data, management and session
sync/heartbeat interfaces, base backplane switching and fabric backplane session-aware load balancing for a
FortiGate-7000 series chassis. The FIM-7920E includes an integrated switch fabric and DP2 processors to load
balance millions of data sessions over the chassis fabric backplane to FPM processor modules.

The FIM-7920E can be installed in any FortiGate-7000 series chassis in hub/switch slots 1 or 2. The FIM-7920E
provides four Quad Small Form-factor Pluggable 28 (QSFP28) 100GigE interfaces for a FortiGate-7000 chassis.
Using a 100GBASE-SR4 QSFP28 or 40GBASE-SR4 QSFP+ transceiver, each QSFP28 interface can also be split
into four 10GBASE-SR interfaces.

You can also install FIM-7920Es in a second chassis and operate the chassis in HAmode with another set of
processor modules to provide chassis failover protection.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

686



FortiGate-7000 overview Chapter 6 - FortiGate-7000

FIM-7920E front panel

The FIM-7920E includes the following hardware features:

l Four front panel 100GigEQSFP28 fabric channel interfaces (C1 to C4). These interfaces are connected to
100Gbps networks to distribute sessions to the FPM processor modules installed in chassis slots 3 and up. Using a
100GBASE-SR4 QSFP28 or 40GBASE-SR4 QSFP+ transceiver, each QSFP28 interface can also be split into four
10GBASE-SR interfaces. These interfaces also support creating link aggregation groups (LAGs) that can include
interfaces from both FIM-7920Es.

l Two front panel 10GigE SFP+ interfaces (M1 and M2) that connect to the base backplane channel. These
interfaces are used for heartbeat, session sync, and management communication between FIM-7920Es in different
chassis. These interfaces can also be configured to operate as Gigabit Ethernet interfaces using SFP transceivers,
but should not normally be changed. If you use switches to connect these interfaces, the switch ports should be
able to accept packets with a maximum frame size of at least 1526. The M1 and M2 interfaces need to be on
different broadcast domains. If M1 and M2 are connected to the same switch, Q-in-Q must be enabled on the
switch.

l Four 10/100/1000BASE-T out of band management Ethernet interfaces (MGMT1 to MGMT4).
l One 80Gbps fabric backplane channel for traffic distribution with each FPM installed in the same chassis as the

FIM-7920E.
l One 1Gbps base backplane channel for base backplane with each FPM installed in the same chassis as the FIM-

7920E.
l One 40Gbps fabric backplane channel for fabric backplane communication with the other FIM-7920E in the chassis.
l One 1Gbps base backplane channel for base backplane communication with the other FIM-7920E in the chassis.
l On-board DP2 processors and an integrated switch fabric to provide high-capacity session-aware load balancing.
l One front panel USB port.
l Power button.
l NMI switch (for troubleshooting as recommended by Fortinet Support).
l Mounting hardware.
l LED status indicators.

Changing the interface type and splitting the FIM-7920E C1 to C4 interfaces

By default, the FIM-7920E C1 to C4 interfaces are configured as 100GEQSFP28 interfaces. You can use the
following command to convert them to 40GEQSFP+ interfaces. Once converted, you can use the other
command below to split them into four 10GBASE-SR interfaces.
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Changing the interface type

For example, to change the interface type of the C1 interface of the FIM-7920E in slot 1 to 40GEQSFP+ connect
to the CLI of your FortiGate-7000 system using the management IP and enter the following command:

config system global
set qsfp28-40g-port 1-C1

end

The FortiGate-7000 system reboots and when it starts up interface C1 of the FIM-7920E in slot 1 is operating as
a 40GEQSFP+ interface .

To change the interface type of the C3 and C4 ports of the FIM-7920E in slot 2 to 40GEQSFP+ enter the
following command:

config system global
set qsfp28-40g-port 2-C3 2-C4

end

The FortiGate-7000 system reboots and when it starts up interfaces C3 and C4 of the FIM-7920E in slot 2 are
operating as a 40GEQSFP+ interfaces.

Splitting the C1 to C4 interfaces

Each 40GE interface (C1 to C4) on the FIM-7920Es in slot 1 and slot 2 of a FortiGate-7000 system can be split
into 4 x 10GBE interfaces. You split these interfaces after the FIM-7920Es are installed in your FortiGate-7000
system and the system us up and running. You can split the interfaces of the FIM-7920Es in slot 1 and slot 2 at
the same time by entering a single CLI command. Splitting the interfaces requires a system reboot so Fortinet
recommends that you split multiple interfaces at the same time according to your requirements to avoid traffic
disruption.

For example, to split the C1 interface of the FIM-7920E in slot 1 (this interface is named 1-C1) and the C1 and C4
interfaces of the FIM-7920E in slot 2 (these interfaces are named 2-C1 and 2-C4) connect to the CLI of your
FortiGate-7000 system using the management IP and enter the following command:

config system global
set split-port 1-C1 2-C1 2-C4

end

After you enter the command, the FortiGate-7000 reboots and when it comes up:

l The 1-C1 interface will no longer be available. Instead the 1-C1/1, 1-C1/2, 1-C1/3, and 1-C1/4 interfaces will be
available.

l The 2-C1 interface will no longer be available. Instead the 2-C1/1, 2-C1/2, 2-C1/3, and 2-C1/4 interfaces will be
available.

l The 2-C4 interface will no longer be available. Instead the 2-C4/1, 2-C4/2, 2-C4/3, and 2-C4/4 interfaces will be
available.

You can now connect breakout cables to these interfaces and configure traffic between them just like any other
FortiGate interface.

FIM-7920E hardware schematic
The FIM-7920E includes an integrated switch fabric (ISF) that connects the front panel interfaces to the DP2
session-aware load balancers and to the chassis backplanes. The ISF also allows the DP2 processors to
distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the FortiGate-7000
chassis.
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FIM-7920E hardware schematic

FPM-7620E processing module
The FPM-7620E processing module is a high-performance worker module that processes sessions load balanced
to it by FortiGate-7000 series interface (FIM) modules over the chassis fabric backplane. The FPM-7620E can be
installed in any FortiGate-7000 series chassis in slots 3 and up.

The FPM-7620E includes two 80Gbps connections to the chassis fabric backplane and two 1Gbps connections to
the base backplane. The FPM-7620E processes sessions using a dual CPU configuration, accelerates network
traffic processing with 4 NP6 processors and accelerates content processing with 8 CP9 processors. The NP6
network processors are connected by the FIM switch fabric so all supported traffic types can be fast path
accelerated by the NP6 processors.

The FPM-7620E includes the following hardware features:

l Two 80Gbps fabric backplane channels for load balanced sessions from the FIMs installed in the chassis.
l Two 1Gbps base backplane channels for management, heartbeat and session sync communication.
l Dual CPUs for high performance operation.
l Four NP6 processors to offload network processing from the CPUs.
l Eight CP9 processors to offload content processing and SSL and IPsec encryption from the CPUs.
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FPM-7620E front panel

l Power button.
l NMI switch (for troubleshooting as recommended by Fortinet Support).
l Mounting hardware.
l LED status indicators.

NP6 network processors - offloading load balancing and network traffic

In a FortiGate-7000 chassis, FPM-7620E NP6 network processors combined with the FortiGate Interface Module
(FIM) Integrated Switch Fabric (ISF) provide hardware acceleration by offloading sessions from the FPM-7620E
CPUs. The result is enhanced network performance provided by the NP6 processors plus the removal of network
processing load from the FPM-7620 CPUs. The NP6 processors can also handle some CPU-intensive tasks, like
IPsec VPN encryption/decryption. Because of the ISF in each FIM, all sessions are fast-pathed and accelerated.

FPM-7620E hardware architecture
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Accelerated IPS, SSL VPN, and IPsec VPN (CP9 content processors)
The FPM-7620E includes eight CP9 processors that provide the following performance enhancements:

l Flow-based inspection (IPS, application control etc.) pattern matching acceleration with over 10Gbps throughput
l IPS pre-scan
l IPS signature correlation
l Full match processors

l High performance VPN bulk data engine
l IPsec and SSL/TLS protocol processor
l DES/3DES/AES128/192/256 in accordance with FIPS46-3/FIPS81/FIPS197
l MD5/SHA-1/SHA256/384/512-96/128/192/256 with RFC1321 and FIPS180
l HMAC in accordance with RFC2104/2403/2404 and FIPS198
l ESNmode
l GCM support for NSA "Suite B" (RFC6379/RFC6460) including GCM-128/256; GMAC-128/256

l Key Exchange Processor that supports high performance IKE and RSA computation
l Public key exponentiation engine with hardware CRT support
l Primary checking for RSA key generation
l Handshake accelerator with automatic key material generation
l True Random Number generator
l Elliptic Curve support for NSA "Suite B"
l Sub public key engine (PKCE) to support up to 4096 bit operation directly (4k for DH and 8k for RSAwith CRT)

l DLP fingerprint support
l TTTD (Two-Thresholds-Two-Divisors) content chunking
l Two thresholds and two divisors are configurable
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Once you have installed your FortiGate-7000 chassis in a rack and installed FIM interface modules and FPM
processing modules in it, you can power on the chassis and all modules in the chassis will power up.

Whenever a chassis is first powered on, it takes about 5 minutes for all modules to start up and become
completely initialized and synchronized. During this time the chassis will not allow traffic to pass through and you
may not be able to log into the GUI, or if you manage to log in the session could time out as the FortiGate-7000
continues negotiating.

Review the chassis and module front panel LEDs to verify that everything is operating normally. Wait until the
chassis has completely started up and synchronized before making configuration changes.

You can use the diagnose sys ha status command to confirm that the
FortiGate-7000 is completely initialized. If the output from entering this command
hasn't changed after checking for a few minutes you can assume that the system has
initialized. You don't normally have to confirm that the system has initialized, but this
diagnose command is available to verify that the system is initialized.

Once the system has initialized, you have a few options for connecting to the FortiGate-7000 GUI or CLI:

l Log into the GUI by connecting the MGMT1 interface of the FIM in slot 1 to your network. Then browse to
https://192.168.1.99. The default administrator account is admin with no password. For more information about
using the MGMT interfaces for management connections to the FortiGate-7000, see Setting up management
connections on page 692.

l Log into the CLI by connecting the MGMT1 interface of the FIM in slot 1 to your network. Then use an SSH client to
connect to 192.168.1.99 and use the same admin account to log in.

l Log into the CLI with a serial connection to the Console 1 serial port on the FortiGate-7000 management module.
For more information, including the serial port settings, see Connecting to module CLIs using the management
module on page 697.

Setting up management connections
When your FortiGate-7000 first starts up, the MGMT1 to MGMT4 interfaces of both of the FIMs are part of a
static 802.3 aggregate interface with a default IP address of 192.168.1.99. On the GUI or CLI the 802.3
aggregate interface is namedmgmt.
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Example mgmt management interface configuration

Setting up a single management connection

You can configure and manage your FortiGate-7000 by connecting an Ethernet cable to any of the MGMT1 - 4
interfaces of the FIM in slot 1 or slot 2 and logging into the GUI using HTTPS or the CLI using SSH. The default
IP address is 192.168.1.99 and you can log in with the admin administrator account with no password.

For security reasons you should add a password to the admin account before
connecting the chassis to your network.

Setting up redundant management connections

You can set up redundant management connections to your FortiGate-7000 by adding a static 802.3 aggregate
interface to a switch and setting up multiple connections between the switch and the FIM MGMT ports. Then
connect the switch to your network.

LACP is not supported for the mgmt aggregate interface.

You do not have to change the configuration of the FortiGate-7000 to set up redundant management
connections. The following example shows connections between the MGMT 1 interfaces of each FIM to a switch.
The switch is configured with a 802.3 static aggregate interface that includes two ports, one for each MGMT 1
interface. The switch also connects the MGMT 1 interfaces to a management network.
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Example FortiGate-7000 redundant management connections

MGMT1

MGMT1Switch

802.3 static

aggregate interface

Management

network

FIM in slot 1

FIM in slot 2

The following example shows redundant connections between both FIMs and the switch. In this case you need to
add more switch ports to the static aggregate interface on the switch. You do not have to change the
configuration of the FortiGate-7000 to set up this redundant management connection configuration.

Example FortiGate-7000 redundant management connections with redundant connections to each FIM

MGMT1 and MGMT 2FIM in slot 1

FIM in slot 2
MGMT1 and MGMT 2

Switch

802.3 static

aggregate interface

Management

network
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In either of these configurations, for additional redundancy you can use two switches. If you use two redundant
switches, the static aggregate interface should span across both switches.

Managing individual FIMs and FPMs
When you log into the GUI or CLI using the mgmt interface IP address you are actually connected to the primary
(or master) FIM in slot 1 (the address of slot 1 is FIM01). To verify which module you have logged into, the GUI
header banner and the CLI prompt shows the hostname of the module you are logged into. The CLI prompt also
shows slot address in the format <hostname> [<slot address>] #.

In some cases you may want to connect to individual modules. For example, you may want to view the traffic
being processed by a specific FPM. You can connect to the GUI or CLI of individual modules in the chassis using
the system management IP address with a special port number.

For example, if the system management IP address is 192.168.1.99 you can connect to the GUI of the FIM in
slot 1 using the system management IP address (for example, by browsing to https://192.168.1.99). You can also
use the system management IP address followed by the special port number: https://192.168.1.99:44301.

The special port number (in this case 44301) is a combination of the service port (for HTTPS the service port is
443) and the chassis slot number (in this example, 01). The following table lists the special ports to use to
connect to each chassis slot using common admin protocols:

FortiGate-7000 special administration port numbers

Slot Number Slot Address HTTP
(80) HTTPS (443) Telnet

(23) SSH (22)

5 FPM05 8005 44305 2305 2205

3 FPM03 8003 44303 2303 2203

1 FIM01 8001 44301 2301 2201

2 FIM02 8002 44302 2302 2202

4 FPM04 8004 44304 2304 2204

6 FPM06 8006 44306 2306 2206

For example:

l To connect to the GUI of the FIM in slot 3 using HTTPS you would browse to https://192.168.1.99:44303.

The FortiGate-7000 configuration is the same no matter which modem you log into. You can log into different
modules to use FortiView or Monitor GUI pages to view the activity of that module. Even though you can log into
different modules, you should only make configuration changes from the primary FIM; which is the FIM in slot 1.

Managing individual modules from the CLI

From the CLI you can use the following command to switch between chassis slots and perform different
operations on the modules in each slot:

execute load-balance slot {manage | power-off | power-on | reboot} <slot-number>
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Use manage to connect to the CLI of a different module, use power-off, power-on, and reboot to turn off
or turn on the power or reboot the module in <slot-number>.

Using data interfaces for management traffic
Normally, all management traffic connects with the FortiGate-7000 through the FIM MGMT1, MGMT2, MGMT3,
and MGMT4 interfaces. The FortiGate-7000 does also support management traffic connections to the FIM data
interfaces. To enable management connections to these interfaces you must configure the VDOM that the data
interfaces are included in to allow traffic forwarding to the primary FIM. By default, the root VDOM includes all of
the data interfaces. To allow management communication between the root VDOM and the primary FIM, edit the
root VDOM from the CLI and use the following command:

config vdom
edit root

config system settings
set motherboard-traffic-forwarding {icmp | admin}

end

The icmp option, enabled by default, allows you to log into the primary FIM from one of the MGMT interfaces
and use the execute ping command to ping an address through one of the FIM data interfaces. The interface
used depends on the routing configuration.

The admin option allows Telnet, SSH, HTTP, and HTTPS administrator connections from a management PC to
a data interface. You cannot configure data interfaces to accept management connections using non-standard
ports.

Currently, the admin setting is in development and not recommended.

FortiGate-7000 dashboard widgets
The FortiGate-7000 includes a number of custom dashboard widgets that provide extra or custom information for
FortiGate-7000 systems.

Security Fabric

The Security Fabric dashboard widget shows the FIMs and FPMs in your FortiGate-7000 system. You can hover
over the components in the Security Fabric dashboard widget to see details about each components host name,
serial number, model, firmware version, and management IP address.

Interface Bandwidth

You can add Interface Bandwidth dashboard widgets to view traffic in and out of any FortiGate-7000 interface.
You can add an Interface Bandwidth widget to the dashboard for:

l Any physical interface
l Any link aggregation (LAG) interface
l Any member of a LAG
l Any VLAN interface
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l Any IPsec VPN tunnel interface
l Any redundant interface

The displayed data includes all of the traffic processed by the interface, independent of how the traffic is load
balanced.

You can add individual Interface Bandwidth widgets for each interface that you want to monitor. After you have
added the widget you can choose to display traffic for the last hour, 24 hours or week. The data displayed on the
widget updates in real time.

From the CLI, for physical interfaces, you can use the diagnose hardware deviceinfo nic
<interface-name> command to view transmitted and received packets.

For LAG and VLAN interfaces you can display transmitted and received packets using the diagnose netlink
interface list <interface-name> command.

Resource Usage

You can create multiple Resource Usage dashboard widgets to show CPU use, log rate, memory use, session
creation rate, and the number of active sessions for the management board and for individual FPMs. After you
have added the widget you can choose to display data for times ranging between 1 minute to 24 hours.The data
displayed on the widget updates in real time.

Sensor Information

The Sensor Information dashboard widget displays temperature information for the FortiGate-7000 hardware and
allows you to drill down for information about individual temperature sensors.

Connecting to module CLIs using the management module
All FortiGate-7000 chassis includes a front panel management module (also called a shelf manager) on the
chassis front panel. See the system guide for your chassis for details about the management module.

ForiGate-7040E management module front panel

The management module includes two console ports named Console 1 and Console 2 that can be used to
connect to the CLI of the FIM and FPMs in the chassis. As described in the system guide, the console ports are
also used to connect to SMC CLIs of the management module and the FIM and FPMs
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By default when the chassis first starts up Console 1 is connected to the FortiOS CLI of the FIM in slot 1 and
Console 2 is disconnected. The default settings for connecting to each console port are:

Baud Rate (bps) 9600, Data bits 8, Parity None, Stop bits 1, and Flow Control None.

You can use the console connection change buttons to select the CLI that each console port is connected to.
Press the button to cycle through the FIM and FPM FortiOS CLIs and disconnect this console. The console's
LEDs indicate what it is connected to. If no LED is lit the console is either connected to the management module
SMC SDI console or disconnected. Both console ports cannot be connected to the same CLI at the same time. If
a console button press would cause a conflict that module is skipped. If one of the console ports is disconnected
then the other console port can connect to any CLI.

If you connect a PC to one of the management module console ports with a serial cable and open a terminal
session you begin by pressing Ctrl-T to enable console switching mode. Press Ctrl-T multiple times to cycle
through the FIM and FPM FortiOS CLIs (the new destination is displayed in the terminal window). If you press
Ctrl-T after connecting to the FPM in the highest slot number, the console is disconnected. Press Ctrl-T again to
start over again at slot 1.

Once the console port is connected to the CLI that you want to use, press Enter to enable the CLI and login. The
default administrator account for accessing the FortiOS CLIs is admin with no password.

When your session is complete you can press Ctrl-T until the prompt shows you have disconnected from the
console.

Connecting to the FortiOS CLI of the FIM in slot 1

Use the following steps to connect to the FortiOS CLI of the FIM in slot 1:

1. Connect the console cable supplied with your chassis to Console 1 and to your PC or other device RS-232 console
port.

2. Start a terminal emulation program on the management computer. Use these settings:
Baud Rate (bps) 9600, Data bits 8, Parity None, Stop bits 1, and Flow Control None.

3. Press Ctrl-T to enter console switch mode.
4. Repeat pressing Ctrl-T until you have connected to slot 1. Example prompt:

<Switching to Console: FIM01 (9600)>

5. Login with an administrator name and password.
The default is admin with no password. For security reasons, it is strongly recommended that you change the
password.

6. When your session is complete, enter the exit command to log out.

Default VDOM configuration
By default when the FortiGate-7000 first starts up it is operating in multiple VDOM mode. The system has a
management VDOM (named mgmt-vdom) and the root VDOM. All management interfaces are in mgmt and all
other interfaces are in the root VDOM. You can add more VDOMs and add interfaces to them or just use the root
VDOM.

Default management VDOM

By default the FortiGate-7000 configuration includes a management VDOM named mgmt-vdom. For the
FortiGate-7000 system to operate normally you should not change the configuration of this VDOM and this
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VDOM should always be the management VDOM. You should also not add or remove interfaces from this
VDOM.

You have full control over the configurations of other FortiGate-7000 VDOMs.

Firmware upgrades
All of the FIMs and FPMs in your FortiGate-7000 system run the same firmware image. You upgrade the
firmware from the primary FIM GUI or CLI just as you would any FortiGate product. During the upgrade process,
the firmware running on all of the FIMs and FPMs upgrades in one step. Firmware upgrades should be done
during a quiet time because traffic will briefly be interrupted during the upgrade process. The entire firmware
upgrade will take a few minutes depending on the number of FIMs and FPMs in your FortiGate-7000 system.
Also, some firmware upgrades may take longer depending on other factors such as the size of the configuration
and whether a DP processor firmware upgrade is included.

Before beginning a firmware upgrade, Fortinet recommends the following:

l Review the latest release notes for the firmware version that you are upgrading to.
l Verify the recommended upgrade path as documented in the release notes.
l Backup your FortiGate-7000 configuration.

Fortinet recommends that you review the services provided by your FortiGate-7000
before a firmware upgrade and then again after the upgrade to make sure everything
continues to operate normally. For example, you might want to verify that you can
successfully access an important server used by your organization before the upgrade
and make sure after the upgrade that you can still reach the server and that
performance is comparable. You could also take a snapshot of key performance
indicators (number of sessions, CPU usage, and memory usage) before the upgrade
and verify that you see comparable performance after the upgrade.

Verifying that a firmware upgrade is successful

After a FortiGate-7000 firmware upgrade, you should verify that all of the FIMs and FPMs have been successfully
upgraded to the new firmware version.

After the firmware upgrade appears to be complete:

1. Log into the primary FIM and verify that it is running the expected firmware version.
You can verify the firmware version running on the primary FIM from the dashboard or by using the get system
status command.

2. Log into the other FIMs and the FPMs, and in the same way confirm that they are also running the expected
firmware version.
You can log into individual FIMs or FPMs using the system management IP address and the special port number
for each module. For example, https://192.268.1.99:44303 connects to the FPM in slot 3. The special port
number (in this case 44303) is a combination of the service port (for HTTPS the service port is 443) and the slot
number (in this example, 03). For more information, see Managing individual FIMs and FPMs on page 695.
If you are using a management module console port to connect to the primary FIM CLI you can use Ctrl-T to
switch between the CLIs of each of the modules.
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Upgrading the firmware running on individual FIMs or FPMs

If, after a firmware upgrade or at any time, one or more of the FIMs or FPMs are not running the correct firmware
version, use the procedures described in Installing firmware on individual FIMs and FPMs on page 715 to
upgrade these FIMs or FPMs.

Upgrading the firmware running on a FortiGate-7000 HA cluster

For information about upgrading FortiGate-7000 HA cluster firmware, see HA cluster firmware upgrades on page
738.

Limitations of installing FortiGate-7000 firmware from the BIOS after a reboot

A common method for resetting the configuration of a FortiGate involves installing firmware by restarting the
FortiGate, interrupting the boot process, and using BIOS prompts to download a firmware image from a TFTP
server. This process is also considered the best way to reset the configuration of your FortiGate.

Installing or upgrading FortiGate-7000 firmware in this way installs firmware on and resets the configuration of
the primary FIM only. The other FIM and the FPMs will continue to operate with their current configuration and
firmware build. The FortiGate-7000 system does not synchronize firmware upgrades performed from the BIOS.

To also reset all of the FIMs and FPCs, after installing firmware from the BIOS on the primary FIM, install the
same firmware image (or optionally a newer firmware image) from the GUI or from the CLI using the execute
restore image command. This operation synchronizes the same firmware build and reset configuration to the
FIMs and FPCs.

You could also manually install firmware on each individual FIM and FPM from the BIOS after a reboot. This
manual process is just as effective as installing the firmware for a second time on the primary FIM to trigger
synchronization to the FIM and FPMs, but takes much longer.

Restarting the FortiGate-7000
To restart all of the modules in a FortiGate-7000 chassis, connect to the primary FIM CLI and enter the command
execute reboot. When you enter this command all of the modules in the chassis reboot.

You can restart individual modules by logging into that module's CLI and entering the execute reboot
command.

Configuration synchronization
The FortiGate-7000 synchronizes the configuration to all modules in the chassis. To support this feature, the FIM
in slot 1 becomes the config-sync master and this FIM makes sure the configurations of all modules are
synchronized. Every time you make a configuration change you must be logged into the chassis using the
management address, which logs you into the config-sync master. All configuration changes made to the config-
sync master are synchronized to all of the modules in the chassis.

If the FIM in slot 1 fails or reboots, the FIM in slot 2 becomes the config-sync master.

Packet sniffing for FIM and FPM packets
You can use the diagnose sniffer packet command to view or sniff packets as they are processed by
FIM or FPMs. To use this command you have to be logged into a VDOM. You can run this command from any
FIM or FPM CLI.
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The command output includes the address of the slot containing the module that processed the packet. From the
primary FIM, you can see packets processed by all of the FIMs and FPMs. From individual FIMs or FPMs you can
see packets processed by that FIM or FPM.

From the primary FIM, you can enter the diagnose sniffer options slot currrent command to
only see packets processed by the primary FIM. You can also enter the diagnose sniffer options slot
default command to see packets processed by all modules.

The command syntax is:

diagnose sniffer packet <interface> <protocol-filter> <verbose> <count> <timestamp> <slot>

Where:

<interface> is the name of one or more interfaces on which to sniff for packets. Use any to sniff packets for
all interfaces. To view management traffic use the elbc-base-ctrl interface name.

<protocol-filter> a filter to select the protocol for which to view traffic. This can be simple, such as
entering udp to view UDP traffic or complex to specify a protocol, port, and source and destination interface and
so on.

<verbose> the amount of detail in the output, and can be:

l 1 display packet headers only.
l 2 display packet headers and IP data.
l 3 display packet headers and Ethernet data (if available).
l 4 display packet headers and interface names.
l 5 display packet headers, IP data, and interface names.
l 6 display packet headers, Ethernet data (if available), and interface names.

<count> the number of packets to view. You can enter Ctrl-C to stop the sniffer before the count is reached.

<timestamp> the timestamp format, a for UTC time and l for local time.

Sample diagnose sniffer packet output from the primary FIM

[FPM04] 1.598890 3ffe:1:1:4::97b.13344 -> 3ffe:1:2:4::105.25: syn 151843506
[FPM03] 1.214394 802.1Q vlan#4022 P0 3ffe:1:1:2::214.10012 -> 3ffe:1:2:2::103.53:
udp 30
[FIM02] 2.177930 llc unnumbered, 23, flags [poll], length 40
[FIM01] 1.583778 172.30.248.99.57167 -> 10.160.19.70.443: ack 2403720303
[FPM04] 1.598891 17.3.8.3.14471 -> 18.3.1.107.143: syn 2715027438 ^C
[FPM03] 1.214395 3ffe:1:1:2::214.10012 -> 3ffe:1:2:2::103.53: udp 30
[FIM01] 1.583779 172.30.248.99.57167 -> 10.160.19.70.443: ack 2403720303

FortiGate-7000 support for VRRP
The FortiGate-7000 platform supports the Virtual Router Redundancy Protocol (VRRP), allowing you to configure
VRRPHA between FortiGate-7000 devices. You can also add a FortiGate-7000 to a VRRP group with other
VRRP routers.

Configure VRRP on the FortiGate-7000 by creating a VRRP group and adding one or more front panel interfaces
to the group.

During normal operation, the primary FortiGate-7000 sends outgoing VRRP routing advertisements. Both the
primary and backup FortiGate-7000s listen for incoming VRRP advertisements from other routers in the VRRP
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group. If the primary FortiGate-7000 fails, the new primary FortiGate-7000 takes over the role of both sending
and receiving VRRP advertisements, maintaining the FortiGate-7000 within the VRRP group.
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This chapter provides an overview of how FortiGate-7000 Session-Aware Load Balancing (SLBC) works and then
breaks down the details and explains why you might want to change some load balancing settings.

FortiGate-7000 SLBC works as follows.

1. SLBC attempts to match all incoming sessions with a configured flow rule (see Load balancing and flow rules on
page 703). If a session matches a flow rule, the session is directed according to the action setting of the flow rule.
Usually flow rules send traffic that can't be load balanced to a specific FPM.

2. TCP, UDP, SCTP, ICMP (IPv4 only) and ESP (IPv4 only) sessions that do not match a flow rule are directed to the
DP2 processors.
The DP2 processors distribute sessions to the FPMs according to the load balancing method set by the dp-
load-distribution-method option of the config load-balance setting command.

3. All other sessions are sent to the primary FPM.

Setting the load balancing method
Sessions are load balanced or distributed based on the load balancing method set by the following command:

config load-balance setting
set dp-load-distribution-method {to-master | src-ip | dst-ip | src-dst-ip | src-ip-

sport | dst-ip-dport | src-dst-ip-sport-dport}
end

Where:

to-master directs all session to the primary FPM. This method is for troubleshooting only and should not be
used for normal operation. Directing all sessions to the primary FPM will have a negative impact on performance.

src-ip sessions are distributed across all FPMs according to their source IP address.

dst-ip sessions are statically distributed across all FPMs according to their destination IP address.

src-dst-ip sessions are distributed across all FPMs according to their source and destination IP addresses.

src-ip-sport sessions are distributed across all FPMs according to their source IP address and source port.

dst-ip-dport sessions are distributed across all FPMs according to their destination IP address and
destination port.

src-dst-ipsport-dport sessions are distributed across all FPMs according to their source and destination
IP address, source port, and destination port. This is the default load balance algorithm and represents true
session-aware load balancing. All session information is taken into account when deciding where to send new
sessions and where to send additional packets that are part of an already established session.

The src-ip and dst-ip load balancing methods use layer 3 information (IP addresses) to identify and load
balance sessions. All of the other load balancing methods (except for to-master) use both layer 3 and layer 4
information (IP addresses and port numbers) to identify a TCP and UDP session. The layer 3 and layer 4 load
balancing methods only use layer 3 information for other types of traffic (SCTP, ICMP, and ESP). If GTP load
balancing is enabled, Tunnel Endpoint Identifiers (TEIDs) are used to identify GTP sessions.
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Flow rules for sessions that cannot be load balanced
Some traffic types cannot be load balanced. Sessions for traffic types that cannot be load balanced should
normally be sent to the primary (or master) FPM by configuring flow rules for that traffic. You can also configure
flow rules to send traffic that cannot be load balanced to specific FPMs.

Create flow rules using the config loadbalance flow-rule command. The default configuration uses
this command to send IKE, GRE, session helper, Kerberos, BGP, RIP, IPv4 and IPv6 DHCP, PPTP, BFD, IPv4
multicast and IPv6 multicast to the primary FPM. You can view the default configuration of the config
loadbalance flow-rule command to see how this is all configured. For example, the following
configuration sends all IKE sessions to the primary FPM:

config load-balance flow-rule
edit 1

set status enable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 500-500
set dst-l4port 500-500
set action forward
set forward-slot master
set priority 5
set comment "ike"

next
edit 2

set status disable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 4500-4500
set dst-l4port 0-0
set action forward
set forward-slot master
set priority 5
set comment "ike-natt src"

next
edit 3

set status disable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 0-0
set dst-l4port 4500-4500
set action forward
set forward-slot master
set priority 5
set comment "ike-natt dst"

next

See Default configuration for traffic that cannot be load balanced on page 707 for a listing of all of the default
configuration flow rules.
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Determining the primary FPM
You can use the diagnose load-balance status command to determine which FPM is operating as the
primary FPM. The primary FPM is also responsible for dynamic routing.

Example diagnose load-balance status output for a FortiGate-7060E showing that the FPM in slot 3 is
the primary (master) FPM. The command output also shows the status of all of the FPMs in the FortiGate-7060E.
The output also shows that the FPM in slot 4 is either missing or down.

diagnose load-balance status
==========================================================================
Slot: 2 Module SN: FIM04E3E16000222

FIM02: FIM04E3E16000222
Master FPM Blade: slot-3

Slot 3: FPM20E3E17900133
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 4:
Status:Dead Function:Active
Link: Base: Up Fabric: Down
Heartbeat: Management: Failed Data: Failed
Status Message:"Waiting for management heartbeat."

.

.

.

SSL VPN load balancing
FortiGate-7000s do not support load balancing SSL VPN sessions terminated by the FortiGate-7000. The
recommended configuration is to direct SSL VPN sessions terminated by the FortiGate-7000 to the primary FPM.

SSL VPN sessions are sessions from an SSL VPN client to your configured SSL VPN
server listening port.

Using a FortiGate-7000 as an SSL VPN server requires you to manually add an SSL VPN load balance flow rule to
configure the FortiGate-7000 to send all SSL VPN sessions to the primary (master) FPC. To match with the SSL
VPN server traffic, the rule should include a destination port that matches the destination port of the SSL VPN
server. A basic rule to allow SSL VPN traffic could be:

config load-balance flow-rule
edit 0

set status enable
set ether-type ipv4
set protocol tcp
set dst-l4port 10443-10443
set forward-slot master
set comment "ssl vpn server to primary FPM"

next
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end

This flow rule matches all sessions sent to port 10443 (the default SSL VPN server listening port) and sends these
sessions to the primary FPM. This should match all of your SSL VPN traffic if you are using the default SSL
VPN server listening port (10443). This flow rule also matches all other sessions using 10443 as the destination
port so all of this traffic is also sent to the primary FPM.

Adding the SSL VPN server IP address

You can add the IP address of the FortiGate-7000 interface that receives SSL VPN traffic to the SSL VPN flow
rule to make sure that the flow rule only matches SSL VPN server settings. For example, if the IP address of the
interface is 172.25.176.32 and the SSL VPN flow rule ID is 26:

config load-balance flow-rule
edit 26

set status enable
set ether-type ipv4
set protocol tcp
set dst-addr-ipv4 172.25.176.32 255.255.255.0
set dst-l4port 10443-10443
set forward-slot master
set comment "ssl vpn server to primary FPM"

next
end

This flow rule will now only match SSL VPN sessions with 172.25.176.32 as the destination address and send all
of these sessions to the primary FPM.

If you change the SSL VPN server listening port

If you have changed the SSL VPN server listening port to 20443, you can change the SSL VPN flow rule as
follows. This example also sets the source interface to port12, which is the SSL VPN server interfaces, instead of
adding the IP address of port12 to the configuration:

config load-balance flow-rule
edit 26

set status enable
set ether-type ipv4
set protocol tcp
set src-interface port12
set dst-l4port 20443-20443
set forward-slot master
set comment "ssl vpn server to primary FPM"

next
end

GTP load balancing
You can use the following command to enable or disable GTP load balancing.

config load-balance setting
config gtp-load-balance {disable | enable}

end

By default, this option is disabled and GTP load balancing is disabled. The following flow rule is enabled and GTP
traffic is directed to the primary (master) FPM.

config load-balance flow-rule
edit 17
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set ether-type ipv4
set protocol udp
set dst-l4port 2123-2123
set comment "gtp-c to master blade"

next
end

When the gtp-load-balance option is enabled, the GTP load balancing is flow rule is disabled and GTP
sessions are directed to the DP2 processors and load balanced to the FPMs.

Default configuration for traffic that cannot be load balanced
The default FortiGate-7000 configure load-balance flow-rule command contains the recommended
default rules for how the FortiGate-7000 handles traffic types that cannot be load balanced. All of these flow rules
identify the traffic type using the options available in the command and direct the traffic to the primary (or master)
FPM. The rules also include a comment that identifies the traffic type.

Most of the flow rules are enabled (status set to enable) and they will direct matching traffic to the primary
FPM. However, the configuration does include some disabled flow rules. You can enable these flow rules if
required for your network.

The CLI syntax below was created with the show command and just shows the configuration changes. All other
options are set to their defaults. Flow rules with no status option are disabled be default. Also the default
forward-slot setting is master, which directs matching traffic to the primary FPM.

config load-balance flow-rule
edit 1

set status disable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 88-88
set dst-l4port 0-0
set action forward
set forward-slot master
set priority 5
set comment "kerberos src"

next
edit 2

set status disable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 0-0
set dst-l4port 88-88
set action forward
set forward-slot master
set priority 5
set comment "kerberos dst"

next
edit 3

set status enable
set vlan 0
set ether-type ip
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set protocol tcp
set src-l4port 179-179
set dst-l4port 0-0
set tcp-flag any
set action forward
set forward-slot master
set priority 5
set comment "bgp src"

next
edit 4

set status enable
set vlan 0
set ether-type ip
set protocol tcp
set src-l4port 0-0
set dst-l4port 179-179
set tcp-flag any
set action forward
set forward-slot master
set priority 5
set comment "bgp dst"

next
edit 5

set status enable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 520-520
set dst-l4port 520-520
set action forward
set forward-slot master
set priority 5
set comment "rip"

next
edit 6

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ::/0
set protocol udp
set src-l4port 521-521
set dst-l4port 521-521
set action forward
set forward-slot master
set priority 5
set comment "ripng"

next
edit 7

set status enable
set vlan 0
set ether-type ipv4
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set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 0.0.0.0 0.0.0.0
set protocol udp
set src-l4port 67-67
set dst-l4port 68-68
set action forward
set forward-slot master
set priority 5
set comment "dhcpv4 server to client"

next
edit 8

set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 0.0.0.0 0.0.0.0
set protocol udp
set src-l4port 68-68
set dst-l4port 67-67
set action forward
set forward-slot master
set priority 5
set comment "dhcpv4 client to server"

next
edit 9

set status disable
set vlan 0
set ether-type ip
set protocol tcp
set src-l4port 1723-1723
set dst-l4port 0-0
set tcp-flag any
set action forward
set forward-slot master
set priority 5
set comment "pptp src"

next
edit 10

set status disable
set vlan 0
set ether-type ip
set protocol tcp
set src-l4port 0-0
set dst-l4port 1723-1723
set tcp-flag any
set action forward
set forward-slot master
set priority 5
set comment "pptp dst"

next
edit 11

set status enable
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set vlan 0
set ether-type ip
set protocol udp
set src-l4port 0-0
set dst-l4port 3784-3784
set action forward
set forward-slot master
set priority 5
set comment "bfd control"

next
edit 12

set status enable
set vlan 0
set ether-type ip
set protocol udp
set src-l4port 0-0
set dst-l4port 3785-3785
set action forward
set forward-slot master
set priority 5
set comment "bfd echo"

next
edit 13

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ::/0
set protocol udp
set src-l4port 547-547
set dst-l4port 546-546
set action forward
set forward-slot master
set priority 5
set comment "dhcpv6 server to client"

next
edit 14

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ::/0
set protocol udp
set src-l4port 546-546
set dst-l4port 547-547
set action forward
set forward-slot master
set priority 5
set comment "dhcpv6 client to server"

next
edit 15

set status enable
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set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 224.0.0.0 240.0.0.0
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv4 multicast"

next
edit 16

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ff00::/8
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv6 multicast"

next
edit 17

set status disable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 0.0.0.0 0.0.0.0
set protocol udp
set src-l4port 0-0
set dst-l4port 2123-2123
set action forward
set forward-slot master
set priority 5
set comment "gtp-c to master blade"

next
edit 18

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ::/0
set protocol udp
set src-l4port 0-0
set dst-l4port 500-500
set action forward
set forward-slot master
set priority 5
set comment "ipv6 ike"

next
edit 19

set status enable
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set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ::/0
set protocol udp
set src-l4port 0-0
set dst-l4port 4500-4500
set action forward
set forward-slot master
set priority 5
set comment "ipv6 ike-natt dst"

next
edit 20

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ::/0
set protocol esp
set action forward
set forward-slot master
set priority 5
set comment "ipv6 esp"

next
edit 21

set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 0.0.0.0 0.0.0.0
set protocol udp
set src-l4port 0-0
set dst-l4port 500-500
set action forward
set forward-slot master
set priority 5
set comment "ipv4 ike"

next
edit 22

set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 0.0.0.0 0.0.0.0
set protocol udp
set src-l4port 0-0
set dst-l4port 4500-4500
set action forward
set forward-slot master
set priority 5
set comment "ipv4 ike-natt dst"

next
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edit 23
set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 0.0.0.0 0.0.0.0
set protocol esp
set action forward
set forward-slot master
set priority 5
set comment "ipv4 esp"

next
edit 24

set status enable
set vlan 0
set ether-type ip
set protocol tcp
set src-l4port 0-0
set dst-l4port 1000-1000
set tcp-flag any
set action forward
set forward-slot master
set priority 5
set comment "authd http to master blade"

next
edit 25

set status enable
set vlan 0
set ether-type ip
set protocol tcp
set src-l4port 0-0
set dst-l4port 1003-1003
set tcp-flag any
set action forward
set forward-slot master
set priority 5
set comment "authd https to master blade"

next
edit 26

set status enable
set vlan 0
set ether-type ip
set protocol vrrp
set action forward
set forward-slot all
set priority 6
set comment "vrrp to all blades"

next
end
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Operating a FortiGate-7000

This chapter describes some FortiGate-7000 general operating procedure.

Failover in a standalone FortiGate-7000
A FortiGate-7000 will continue to operate even if one of the FIM or FPMs fails or is removed. If an FPM fails,
sessions being processed by that module fail. All sessions are then load balanced to the remaining FPMs.
Sessions that were being processed by the failed module are restarted and load balanced to the remaining FPMs.

If an FIM fails, the other FIM will continue to operate and will become the config-sync master. However, traffic
received by the failed FIM will be lost.

You can use LACP or redundant interfaces to connect interfaces of both FIMs to the same network. In this way, if
one of the FIMs fails the traffic will continue to be received by the other FIM.

Replacing a failed FPM or FIM
This section describes how to remove a failed FPM or FIM and replace it with a new one. The procedure is slightly
different depending on if you are operating in HAmode with two chassis or just operating a standalone chassis.

Replacing a failed module in a standalone FortiGate-7000 chassis

1. Power down the failed module by pressing the front panel power button.
2. Remove the module from the chassis.
3. Insert the replacement module. It should power up when inserted into the chassis if the chassis has power.
4. The module's configuration is synchronized and its firmware is upgraded to match the firmware version on the

primary module. The new module reboots.
5. Confirm that the new module is running the correct firmware version either from the GUI or by using the get

system status command.
Manually update the module to the correct version if required. You can do this by logging into the module and
performing a firmware upgrade. See Installing firmware on individual FIMs and FPMs on page 715.

6. Verify that the configuration has been synchronized.
The following command output shows the sync status of the FIMs in a FortiGate-7000 chassis. The field in_
sync=1 indicates that the configurations of the modules are synchronized.
diagnose sys confsync
status | grep in_sy
FIM04E3E16000080, Slave, uptime=177426.45, priority=2,
slot_id=1:2, idx=0, flag=0x0, in_sync=1
FIM10E3E16000063, Master, uptime=177415.38, priority=1,
slot_id=1:1, idx=1, flag=0x0, in_sync=1

If in_sync is not equal to 1 or if a module is missing in the command output you can try restarting the
modules in the chassis by entering execute reboot from any module CLI. If this does not solve the problem,
contact Fortinet support.

Replacing a failed module in a FortiGate-7000 chassis in an HA cluster

1. Power down the failed module by pressing the front panel power button.
2. Remove the module from the chassis.
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3. Insert the replacement module. It should power up when inserted into the chassis if the chassis has power.
4. The module's configuration is synchronized and its firmware is upgraded to match the configuration and firmware

version on the primary module. The new module reboots.
5. Confirm that the module is running the correct firmware version.

Manually update the module to the correct version if required. You can do this by logging into the module and
performing a firmware upgrade.

6. Configure the new module for HA operation. For example:
config system ha

set mode a-p
set chassis-id 1
set hbdev m1 m2
set hbdev-vlan-id 999
set hbdev-second-vlan-id 990

end
7. Optionally configure the hostname:

config system global
set hostname <name>

end

The HA configuration and the hostname must be set manually because HA settings and the hostname is not
synchronized.

8. Verify that the configuration has been synchronized.
The following command output shows the sync status of the FIMs in a FortiGate-7000 chassis. The field in_
sync=1 indicates that the configurations of the modules are synchronized.
diagnose sys confsync
status | grep in_sy
FIM04E3E16000080, Slave, uptime=177426.45, priority=2,
slot_id=1:2, idx=0, flag=0x0, in_sync=1
FIM10E3E16000063, Master, uptime=177415.38, priority=1,
slot_id=1:1, idx=1, flag=0x0, in_sync=1

If in_sync is not equal to 1 or if a module is missing in the command output you can try restarting the
modules in the chassis by entering execute reboot from any module CLI. If this does not solve the problem,
contact Fortinet support.

Installing firmware on individual FIMs and FPMs
You can install firmware on individual FIMs or FPMs by logging into the FIM or FPM GUI or CLI. You can also
setup a console connection to the FortiGate-7000 front panel Management Module and install firmware on
individual FIMs or FPMs from a TFTP server after interrupting the FIM or FPM boot up sequence from the BIOS.

Normally you wouldn't need to upgrade the firmware on individual FIMs or FPMs because the FortiGate-7000
keeps the firmware on all of the FIMs and FPMs synchronized. However, FIM or FPM firmware may go out of
sync in the following situations:

l Communication issues during a normal FortiGate-7000 firmware upgrade.
l Installing a replacement FIM or FPM that is running a different firmware version.
l Installing firmware on or formatting an FIM or FPM from the BIOS.

To verify the firmware versions on each FIM or FPM you can check each FIM and FPM GUI or enter the get
system status command from each FIM or FPM CLI. You can also use the diagnose sys confsync
status | grep in_sy command to see if the FIMs and FPMs are all synchronized. In the command output
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in_sync=1 means the FIM or FPM is synchronized. In_sync=0 means the FIM or FPM is not synchronized,
which could indicated the FIM or FPM is running a different firmware build than the primary FIM.

The procedures in this section work for FIMs or FPMs in a standalone FortiGate-7000. These procedures also
work for FIMs or FPMs in the primary FortiGate-7000 in an HA configuration. To upgrade firmware on an FIM or
FPM in the backup FortiGate-7000 in an HA configuration, you should either remove the backup FortiGate-7000
from the HA configuration or cause a failover so that the backup FortiGate-7000 becomes the primary FortiGate-
7000.

In general, if you need to update both FIMs and FPMs in the same FortiGate-7000, you should update the FIMs
first as the FPMs can only communicate through FIM interfaces.

Upgrading FIM firmware

Use the following procedure to upgrade the firmware running on a single FIM. For this procedure to work, you
must connect at least one of the FIM MGMT interfaces to a network. You must also be able to log into the
FIM GUI or CLI from that MGMT interface. If you perform the firmware upgrade from the CLI, the FIM must be
able to communicate with an FTP or TFTP server.

During the upgrade, the FIM will not be able to process traffic. However, the other FIM and the FPMs should
continue to operate normally.

1. Log into the FIM GUI or CLI and perform a normal firmware upgrade.
You may need to use the special port number to log into the FIM in slot two (for example, browse to
https://192.168.1.99:44302).

2. Once the FIM restarts, verify that the new firmware has been installed.
You can do this from the FIM GUI dashboard or from the FIM CLI using the get system status command.

3. Verify that the configuration has been synchronized to the upgraded FIM. The following command output shows
the sync status of a FortiGate-7040E. The field in_sync=1 indicates that the configurations of the FIMs and
FPMs are synchronized.

diagnose sys confsync status | grep in_sy

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x4, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

If in_sync is not equal to 1 or if an FIM or FPM is missing in the command output, you can log into the
FIM or FPM CLI and try to restart it using the execute reboot command. If this does not solve the
problem, contact Fortinet Support.

Upgrading FPM firmware

Use the following procedure to upgrade the firmware running on an individual FPM. To perform the upgrade, you
must enter a command from the primary FIM CLI to allow ELBC communication with the FPM. Then you can just
log into the FPM GUI or CLI and perform the firmware upgrade.

During this procedure, the FPM will not be able to process traffic. However, the other FPMs and the FIMs should
continue to operate normally.
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After you verify that the FPM is running the right firmware, you must log back into the primary FIM CLI and return
the FPM to normal operation.

1. Log into to the primary FIM CLI and enter the following command:
diagnose load-balance switch set-compatible <slot> enable elbc
Where <slot> is the number of the FortiGate-7000 slot containing the FPM to be upgraded.

2. Log into the FPM GUI or CLI using its special port number (for example, for the FPM in slot 3, browse to
https://192.168.1.99:44303 to connect to the GUI) and perform a normal firmware upgrade of the FPM.

3. Once the FPM restarts, verify that the new firmware has been installed.
You can do this from the FPM GUI dashboard or from the FPM CLI using the get system status command.

4. Verify that the configuration has been synchronized. The following command output shows the sync status of a
FortiGate-7040E. The field in_sync=1 indicates that the configurations of the FIMs and FPMs are
synchronized.

diagnose sys confsync status | grep in_sy

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x4, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

If in_sync is not equal to 1 or if an FIM or FPM is missing in the command output, you can log into the
FIM or FPM CLI and try to restart it using the execute reboot command. If this does not solve the
problem, contact Fortinet Support.

5. Once the FPM is operating normally, log back into the primary FIM CLI and enter the following command to reset
the FPM to normal operation:
diagnose load-balance switch set-compatible <slot> disable
Configuration synchronization errors will occur if you do not reset the FPM to normal operation.

Upgrading FIM firmware from the FIM BIOS using a TFTP server

Use the following steps to upload firmware from a TFTP server to an FIM. The procedure involves creating a
connection between the TFTP server and one of the FIM MGMT interfaces. You don't have to use a MGMT
interface on the FIM that you are upgrading.

This procedure also involves connecting to the FIM CLI using a FortiGate-7000 front panel Management Module
console port, rebooting the FIM, interrupting the boot from the console session, and following FIM BIOS prompts
to install the firmware.

During this procedure, the FIM will not be able to process traffic. However, the other FIM and the FPMs should
continue to operate normally.

1. Set up a TFTP server and copy the firmware file to the TFTP server default folder.
2. Set up your network to allow traffic between the TFTP server and one of the FIM MGMT interfaces.

If the MGMT interface you are using is one of the MGMT interfaces connected as a LAG to a switch, you must
shutdown or disconnect all of the other connections in the LAG from the switch. This includes the MGMT
interfaces in the other FIM.
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3. Connect the console cable supplied with your FortiGate-7000 to the front panel Management Module Console 1
port and to your management computer's RS-232 console port.

4. Start a terminal emulation program on the management computer. Use these settings:
Baud Rate (bps) 9600, Data bits 8, Parity None, Stop bits 1, and Flow Control None.

5. Press Ctrl-T to enter console switch mode.
6. Repeat pressing Ctrl-T until you have connected to the FIM to be updated. Example prompt for the FIM in slot 2:

<Switching to Console: FIM02 (9600)>

7. Optionally log into the FIM's CLI.
8. Reboot the FIM.

You can do this using the execute reboot command from the CLI or by pressing the power switch on the FIM
front panel.

9. When the FIM starts up, follow the boot process in the terminal session and press any key when prompted to
interrupt the boot process.

10. Press C to set up the TFTP configuration.
11. Use the BIOSmenu to set the following. Only change settings if required.

[P]: Set image download port: MGMT1

[D]: Set DHCP mode: Disabled

[I]: Set local IP address: The IP address of the MGMT interface, to be used to connect to the
TFTP server. This address must not be the same as the FortiGate-7000 management IP address and cannot
conflict with other addresses on your network

[S]: Set local Subnet Mask: Set as required for your network.

[G]: Set local gateway: Set as required for your network.

[V]: Local VLAN ID: Use -1 to clear the Local VLAN ID.

[T]: Set remote TFTP server IP address: The IP address of the TFTP server.

[F]: Set firmware image file name: The name of the firmware file to be installed.

12. Press Q to quit this menu.
13. Press R to review the configuration.

If you need to make any corrections, press C and make the changes as required. When the configuration is
correct, proceed to the next step.

14. Press T to start the TFTP transfer.
The firmware image is uploaded from the TFTP server and installed on the FIM. The FIM then restarts with its
configuration reset to factory defaults. After restarting, the FIM configuration is synchronized to match the
configuration of the primary FIM. The FIM restarts again and can start processing traffic.

15. Once the FIM restarts, verify that the correct firmware has been installed.
You can do this from the FIM GUI dashboard or from the FPM CLI using the get system status command.

16. Verify that the configuration has been synchronized.
The following command output shows the sync status of a FortiGate-7040E. The field in_sync=1 indicates that
the configurations of the FIMs and FPMs are synchronized.

diagnose sys confsync status | grep in_sy

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x4, in_sync=1
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FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

If in_sync is not equal to 1 or if an FIM or FPM is missing in the command output, you can log into the
FIM or FPM CLI and try restarting it using the execute reboot command. If this does not solve the
problem, contact Fortinet support.

Upgrading FPM firmware from the FPM BIOS using a TFTP server

Use the following steps to upload firmware from a TFTP server to an FPM. To perform the upgrade, you must
enter a command from the primary FIM CLI to allow the FPM BIOS to communicate through an FIM MGMT
interface. The procedure involves creating a connection between the TFTP server and one of the FIM MGMT
interfaces.

This procedure also involves connecting to the FPM CLI using a FortiGate-7000 front panel Management Module
console port, rebooting the FPM, interrupting the boot from the console session, and following FPM BIOS
prompts to install the firmware.

During this procedure, the FPM will not be able to process traffic. However, the other FPMs and the FIMs should
continue to operate normally.

After you verify that the FPM is running the right firmware, you must log back into the primary FIM CLI and return
the FPM to normal operation.

1. Set up a TFTP server and copy the firmware file into the TFTP server default folder.
2. Log into to the primary FIM CLI and enter the following command:

diagnose load-balance switch set-compatible <slot> enable bios
Where <slot> is the number of the FortiGate-7000 slot containing the FPM to be upgraded.

3. Set up your network to allow traffic between the TFTP server and a MGMT interface of one of the FIMs.
You can use any MGMT interface of either of the FIMs. If the MGMT interface you are using is one of the MGMT
interfaces connected as a LAG to a switch you must shutdown or disconnect all of the other connections in the
LAG from the switch. This includes the MGMT interfaces in the other FIM.

4. Connect the console cable supplied with your FortiGate-7000 to the management module Console 1 port and to
your management computer's RS-232 console port.

5. Start a terminal emulation program on the management computer. Use these settings:
Baud Rate (bps) 9600, Data bits 8, Parity None, Stop bits 1, and Flow Control None.

6. Press Ctrl-T to enter console switch mode.
7. Repeat pressing Ctrl-T until you have connected to the module to be updated. Example prompt:

<Switching to Console: FPM03 (9600)>

8. Optionally log into the FPM's CLI.
9. Reboot the FPM.

You can do this using the execute reboot command from the FPM's CLI or by pressing the power switch on
the FPM front panel.

10. When the FPM starts up, follow the boot process in the terminal session and press any key when prompted to
interrupt the boot process.

11. Press C to set up the TFTP configuration.
12. Use the BIOSmenu to set the following. Only change settings if required.
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[P]: Set image download port: The name of the FIM that can connect to the TFTP server (FIM01
is the FIM in slot 1 and FIM02 is the FIM in slot 2).

[D]: Set DHCP mode: Disabled.

[I]: Set local IP address: The IP address of the MGMT interface, to be used to connect to the
TFTP server. This address must not be the same as the FortiGate-7000 management IP address and cannot
conflict with other addresses on your network.

[S]: Set local Subnet Mask: Set as required for your network.

[G]: Set local gateway: Set as required for your network.

[T]: Set remote TFTP server IP address: The IP address of the TFTP server.

[F]: Set firmware image file name: The name of the firmware file to be installed.

13. Press Q to quit this menu.
14. Press R to review the configuration.

If you need to make any corrections, press C and make the changes as required. When the configuration is correct
proceed to the next step.

15. Press T to start the TFTP transfer.
The firmware image is uploaded from the TFTP server and installed on the FPM. The FPM then restarts with its
configuration reset to factory defaults. After restarting, the FPM configuration is synchronized to match the
configuration of the primary FPM. The FPM restarts again and can start processing traffic.

16. Once the FPM restarts, verify that the correct firmware has been installed.
You can do this from the FPM GUI dashboard or from the FPM CLI using the get system status command.

17. Verify that the configuration has been synchronized.
The following command output shows the sync status of a FortiGate-7040E. The field in_sync=1 indicates that
the configurations of the FIMs and FPMs are synchronized.

diagnose sys confsync status | grep in_sy

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x4, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

If in_sync is not equal to 1 or if an FIM or FPM is missing in the command output, you can log into the
FIM or FPM CLI and try restarting it using the execute reboot command. If this does not solve the
problem, contact Fortinet Support.

18. Log back into the primary FIM CLI and enter the following command to reset the FPM to normal operation:
diagnose load-balance switch set-compatible <slot> disable
Configuration synchronization errors will occur if you do not reset the FPM to normal operation.

Synchronizing FIMs and FPMs after upgrading the primary FIM firmware from the BIOS

After installing firmware on the primary FIM from the BIOS after a reboot, the firmware version and configuration
of the primary FIM will most likely be out of synch with other FIMs and FPMs. You can verify this from the primary
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FIM CLI using the diagnose sys confsync status | grep in_sy command. The in_sync=0
entries in the following example output extract show that the management board (serial number ending in 10) is
out of sync with the other FIM and the FPMs shown in the output.

diagnose sys confsync status | grep in_sy

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=0

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=0

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

...

You can also verify synchronization status from management board Security Fabric dashboard widget.

To re-synchronize the FortiGate-7000, (which has the effect of resetting the other FIM and the FPS) you can
install firmware on the primary FIM using a normal firmware install processes.

You could also manually install firmware on each individual FIM and FPM from the
BIOS after a reboot. This manual process is just as effective as installing the firmware
for a second time on the primary FIM to trigger synchronization to the FIM and the
FPMs, but takes much longer.

1. Log into the primary FIM GUI.
2. Click the System Information dashboard widget select Update firmware in System > Firmware.

You can also connect to the management board CLI and use the execute restore image command. Either
operation synchronizes the firmware build and configuration from the primary FIM to the other FIM and the FPMs.
The firmware build you install on the primary FIM can either be the same firmware build or a different one.

3. Once you have installed or re-installed firmware on the primary FIM, check the synchronization status from the
Security Fabric dashboard widget or by using the the diagnose sys confsync status | grep in_sy
command. The output should be similar to the following (shown for a ForGate-7040E):

diagnose sys confsync status | grep in_sy

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x4, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FIM04E3E16000010, Master, uptime=69398.91, priority=1, slot_id=1:1, idx=0, flag=0x0, in_sync=1

FIM10E3E16000040, Slave, uptime=69346.99, priority=2, slot_id=1:2, idx=1, flag=0x0, in_sync=1

FPM20E3E17900217, Slave, uptime=69387.74, priority=20, slot_id=1:4, idx=2, flag=0x64, in_sync=1
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This chapter highlights special FortiGate-7000 VPN features and configurations.

New IPsec VPN features
FortiOS 5.6 includes the following IPsec VPN improvements:

l Including a phase 2 selector is no longer mandatory.
l Dynamic routing (RIP, OSPF, BGP) is supported over IPsec VPN tunnels.

IPsec VPN features supported by FortiOS 5.6 for FortiGate-7000

FortiOS 5.6 for FortiGate-7000 supports the following IPsec VPN features.

l Interface-based IPsec VPN (also called route-based IPsec VPN).
l Static routes can point IPsec VPN interfaces.
l Dynamic routing (RIP, OSPF, BGP) over IPsec VPN tunnels.
l Remote networks with 16- to 32-bit netmasks.
l IPsec VPN tunnels must terminate on the primary FPM (the ELBCmaster).
l Site-to-Site IPsec VPN.
l Dialup IPsec VPN. The FortiGate-7000 can be the dialup server or client.
l IPv4 clear-text traffic (IPv4 over IPv4 or IPv4 over IPv6)

IPsec VPN features not supported by FortiOS 5.6 for FortiGate-7000

FortiOS 5.6 for FortiGate-7000 does not support the following IPsec VPN features.

l Policy-based IPsec VPN.
l Policy routes for VPN traffic.
l Remote networks with 0- to 15-bit netmasks.
l IPv6 clear-text traffic (IPv6 over IPv4 or IPv6 over IPv6).
l Load-balancing IPsec VPN tunnels to multiple FPMs.
l IPsec SA synchronization between both FortiGate-7000s in an HA configuration.

Adding source and destination subnets to IPsec VPN phase 2 configurations
If your FortiGate-7000 configuration includes IPsec VPNs you should enhance your IPsec VPN Phase 2
configurations as described in this section.

Because the FortiGate-7000 only allows 16-bit to 32-bit routes, you must add one or more destination subnets to
your IPsec VPN phase 2 configuration for FortiGate-7000 v5.4.5 using the following command:

config vpn ipsec phase2-interface
edit "to_fgt2"So

set phase1name <name>
set src-subnet <IP> <netmask>
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set dst-subnet <IP> <netmask>
end

Where

src-subnet the subnet protected by the FortiGate that you are configuring and from which users connect to
the destination subnet. Configuring the source subnet is optional but recommended.

dst-subnet the destination subnet behind the remote IPsec VPN endpoint. Configuring the destination subnet
is required.

You can add the source and destination subnets either before or after upgrading to v5.4.5 as these settings are
compatible with both v5.4.3 and v5.4.5. However, if you make these changes after upgrading, your IPsec VPNs
may not work correctly until these configuration changes are made.

Example basic IPsec VPN phase 2 configuration

In a simple configuration such as the one below with an IPsec VPN between two remote subnets you can just add
the subnets to the phase 2 configuration.

Enter the following command to add the source and destination subnets to the FortiGate-7000 IPsec VPN Phase
2 configuration.

config vpn ipsec phase2-interface
edit "to_fgt2"So

set phase1name "to_fgt2"
set src-subnet 172.16.1.0 255.255.255.0
set dst-subnet 172.16.2.0 255.255.255.0

end

Example multiple subnet IPsec VPN phase 2 configuration

In a more complex configuration, such as the one below with a total of 5 subnets you still need to add all of the
subnets to the Phase 2 configuration. In this case you can create a firewall address for each subnet and the
addresses to address groups and add the address groups to the Phase 2 configuration.
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Enter the following commands to create firewall addresses for each subnet.

config firewall address
edit "local_subnet_1"

set subnet 4.2.1.0 255.255.255.0
next
edit "local_subnet_2"

set subnet 4.2.2.0 255.255.255.0
next
edit "remote_subnet_3"

set subnet 4.2.3.0 255.255.255.0
next
edit "remote_subnet_4"

set subnet 4.2.4.0 255.255.255.0
next
edit "remote_subnet_5"

set subnet 4.2.5.0 255.255.255.0
end

And then put the five firewall addresses into two firewall address groups.

config firewall addrgrp
edit "local_group"

set member "local_subnet_1" "local_subnet_2"
next
edit "remote_group"

set member "remote_subnet_3" "remote_subnet_4" "remote_subnet_5"
end

Now, use the firewall address groups in the Phase 2 configuration:

config vpn ipsec phase2-interface
edit "to-fgt2"

set phase1name "to-fgt2"
set src-addr-type name
set dst-addr-type name
set src-name "local_group"
set dst-name "remote_group"

end
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Configuring the FortiGate-7000 as a dialup IPsec VPN server
FortiGate-7000s can be configured as dialup IPsec VPN servers or clients.

Example dialup IPsec VPN server configuration

The following shows how to setup a dialup IPsec VPN configuration where the FortiGate-7000 acts as a dialup
IPsec VPN server.

To configure the FortiGate-7000 as a dialup IPsec VPN server:

Configure the phase1, set type to dynamic.

config vpn ipsec phase1-interface
edit dialup-server

set type dynamic
set interface "v0020"
set peertype any
set psksecret < password>

end

Configure the phase 2, to support dialup IPsec VPN, set the destination subnet to 0.0.0.0 0.0.0.0.

config vpn ipsec phase2-interface
edit dialup-server

set phase1name dialup-server
set src-subnet 4.2.0.0 255.255.0.0
set dst-subnet 0.0.0.0 0.0.0.0

end

To configure the remote FortiGate as a dialup IPsec VPN client

The dialup IPsec VPN client should advertise its local subnet(s) using the phase 2 src-subnet option.

If there are multiple local subnets create a phase 2 for each one. Each phase 2 only
advertises one local subnet to the dialup IPsec VPN server. If more than one local
subnet is added to the phase 2, only the first one is advertised to the server.

Dialup client configuration:

config vpn ipsec phase1-interface
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edit "to-fgt7k"
set interface "v0020"
set peertype any
set remote-gw 1.2.0.1
set psksecret <password>

end
config vpn ipsec phase2-interface

edit "to-fgt7k"
set phase1name "to-fgt7k"
set src-subnet 4.2.6.0 255.255.255.0
set dst-subnet 4.2.0.0 255.255.0.0

next
edit "to-fgt7k-2"

set phase1name "to-fgt7k"
set src-subnet 4.2.7.0 255.255.255.0
set dst-subnet 4.2.0.0 255.255.0.0

end

Troubleshooting
Use the following commands to verify that IPsec VPN sessions are up and running.

Use the diagnose load-balance status command from the primary FIM interface module to determine
the primary FPM processor module. For FortiGate-7000 HA, run this command from the primary FortiGate-7000.
The third line of the command output shows which FPM is operating as the primary FPM.

diagnose load-balance status
FIM01: FIM04E3E16000074
Master FPM Blade: slot-4

Slot 3: FPM20E3E17900113
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 4: FPM20E3E16800033
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

FIM02: FIM10E3E16000040
Master FPM Blade: slot-4

Slot 3: FPM20E3E17900113
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"

Slot 4: FPM20E3E16800033
Status:Working Function:Active
Link: Base: Up Fabric: Up
Heartbeat: Management: Good Data: Good
Status Message:"Running"
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Log into the primary FPM CLI and from here log into the VDOM that you added the tunnel configuration to and
run the command diagnose vpn tunnel list <phase2-name> to show the sessions for the phase 2
configuration. The example below is for the to-fgt2 phase 2 configuration configured previously in this chapter.
The command output shows the security association (SA) setup for this phase 2 and the all of the destination
subnets .

From the command output, make sure the SA is installed and the dst addresses are correct.

CH15 [FPM04] (002ipsecvpn) # diagnose vpn tunnel list name to-fgt2
list ipsec tunnel by names in vd 11
------------------------------------------------------
name=to-fgt2 ver=1 serial=2 4.2.0.1:0->4.2.0.2:0
bound_if=199 lgwy=static/1 tun=intf/0 mode=auto/1 encap=none/40 options[0028]=npu
ike_assit
proxyid_num=1 child_num=0 refcnt=8581 ilast=0 olast=0 auto-discovery=0
ike_asssit_last_sent=4318202512
stat: rxp=142020528 txp=147843214 rxb=16537003048 txb=11392723577
dpd: mode=on-demand on=1 idle=20000ms retry=3 count=0 seqno=2
natt: mode=none draft=0 interval=0 remote_port=0
proxyid=to-fgt2 proto=0 sa=1 ref=8560 serial=8

src: 0:4.2.1.0/255.255.255.0:0 0:4.2.2.0/255.255.255.0:0
dst: 0:4.2.3.0/255.255.255.0:0 0:4.2.4.0/255.255.255.0:0

0:4.2.5.0/255.255.255.0:0
SA: ref=7 options=22e type=00 soft=0 mtu=9134 expire=42819/0B replaywin=2048

seqno=4a26f esn=0 replaywin_lastseq=00045e80
life: type=01 bytes=0/0 timeout=43148/43200
dec: spi=e89caf36 esp=aes key=16 26aa75c19207d423d14fd6fef2de3bcf

ah=sha1 key=20 7d1a330af33fa914c45b80c1c96eafaf2d263ce7
enc: spi=b721b907 esp=aes key=16 acb75d21c74eabc58f52ba96ee95587f

ah=sha1 key=20 41120083d27eb1d3c5c5e464d0a36f27b78a0f5a
dec:pkts/bytes=286338/40910978, enc:pkts/bytes=562327/62082855
npu_flag=03 npu_rgwy=4.2.0.2 npu_lgwy=4.2.0.1 npu_selid=b dec_npuid=3 enc_

npuid=1

Log into the CLI of any of the FIMs and run the command diagnose test application fctrlproxyd
2. The output should show matching destination subnets.

diagnose test application fctrlproxyd 2

fcp route dump : last_update_time 24107

Slot:4
routecache entry: (5)
checksum:27 AE 00 EA 10 8D 22 0C D6 48 AB 2E 7E 83 9D 24
vd:3 p1:to-fgt2 p2:to-fgt2 subnet:4.2.3.0 mask:255.255.255.0 enable:1
vd:3 p1:to-fgt2 p2:to-fgt2 subnet:4.2.4.0 mask:255.255.255.0 enable:1
vd:3 p1:to-fgt2 p2:to-fgt2 subnet:4.2.5.0 mask:255.255.255.0 enable:1
=========================================
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FortiGate-7000 supports a variation of active-passive FortiGate Clustering Protocol (FGCP) high availability (HA)
between two identical FortiGate-7000s. With active-passive FortiGate-7000 HA, you create redundant network
connections to two identical FortiGate-7000s and add redundant HA heartbeat connections. Then you configure
each FortiGate-7000 for HA.The FGCP forms a cluster and selects a primary FortiGate-7000. You can set device
priorities and enable override to select the primary FortiGate-7000.

Example FortiGate-7040 HA configuration

The primary FortiGate-7000 processes all traffic. The backup FortiGate-7000 operates in hot standby mode. The
FGCP synchronizes the configuration, active sessions, routing information, and so on to the backup FortiGate-
7000. If the primary FortiGate-7000 fails, traffic automatically fails over to the backup FortiGate-7000.

New HA features and changes
Configuring FortiGate-7000 HA has been simplified for FortiOS 5.6.6. To set up HA, you no longer have to
configure HA settings for both of the FIMs in a FortiGate-7000. Instead, you configure HA settings on the primary
FIM and this configuration is synchronized to the other FIM.

As well, FortiGate-7000 HA is configured and operates more like standard FGCPHA. The link failure threshold
concept that was part of FortiGate-7000 for FortiOS 5.4 has been removed and board failover tolerance has been
simplified. As well, primary unit selection has been simplified to be more like FGCP primary unit selection.
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FortiOS 5.6.6 also includes the following new features and changes:

l The System > HA GUI page now appears and can be used to configure most HA settings.
l You can configure HA interface monitoring (or port monitoring) to detect link failures.
l You can configure HA remote link failover (also called remote IPmonitoring) to detect remote link failures using the

following options:
l Enable remote IPmonitoring with the pingserver-monitor-interface option.
l Set the remote IPmonitoring failover threshold with the pingserver-failover-threshold option.
l Force the cluster to negotiate after a remote IPmonitoring failover with the pingserver-slave-
force-reset option.

l Adjust the time to wait in minutes before renegotiating after a remote IPmonitoring failover with the
pingserver-flip-timeout option.

l You can use the get system ha status command to display HA status. The diagnose sys ha status
command is no longer available.

l The diagnose sys ha force-slave-state command is no longer available. To force the primary
FortGate-7000 into a backup (or slave) state you can use the diagnose sys ha reset-uptime command.

l The HA link-failure-threshold option has been removed.
l The board-failover-tolerance option has been simplified and determines how the cluster responds to

failed FIMs.

Before you begin configuring HA
Before you begin, the FortiGate-7000s to be added to an HA cluster should be running the same FortiOS
firmware version and interfaces should not be configured to get their addresses from DHCP or PPPoE. Register
and apply licenses to the each FortiGate-7000 before setting up the HA cluster. This includes licensing for
FortiCare, IPS, AntiVirus, Web Filtering, Mobile Malware, FortiClient, FortiCloud, and additional virtual domains
(VDOMs). Both FortiGate-7000s in the cluster must have the same level of licensing for FortiGuard, FortiCloud,
FortiClient, and VDOMs. FortiToken licenses can be added at any time because they are synchronized to all
cluster members.

Configure split ports

If required, you should configure split ports on the FIMs on both FortiGate-7000s before configuring HA because
the FortiGate-7000 has to reboot to enable the split port configuration.

For example, to split the C1, C2, and C4 interfaces of an FIM-7910E in slot 1, enter the following command:

config system global
set split-port 1-C1 2-C1 2-C4

end

After configuring split ports, the FortiGate-7000 reboots and synchronizes the configuration.

On each FortiGate-7000, make sure configurations of the FIMs and FPMs are synchronized before starting to
configure HA. You can use the following command to verify the synchronization status of all modules:

diagnose sys confsync showchsum | grep all
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e
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all: c0 68 d2 67 e1 23 d9 3a 10 50 45 c5 50 f1 e6 8e

If the modules are synchronized, the checksums displayed should all be the same.

You can also use the following command to list the modules that are synchronized. The example output shows all
four modules in a FortiGate-7040E have been configured for HA and added to the cluster.

diagnose sys confsync status | grep in_sync

FIM10E3E16000062, Slave, uptime=58852.50, priority=2, slot_id=2:2, idx=3, flag=0x10, in_sync=1

FIM04E3E16000010, Slave, uptime=58726.83, priority=3, slot_id=1:1, idx=0, flag=0x10, in_sync=1

FIM04E3E16000014, Master, uptime=58895.30, priority=1, slot_id=2:1, idx=1, flag=0x10, in_sync=1

FIM10E3E16000040, Slave, uptime=58857.80, priority=4, slot_id=1:2, idx=2, flag=0x10, in_sync=1

FPM20E3E16900234, Slave, uptime=58895.00, priority=16, slot_id=2:3, idx=4, flag=0x64, in_sync=1

FPM20E3E16900269, Slave, uptime=58333.37, priority=120, slot_id=2:4, idx=5, flag=0x64, in_sync=1

FPM20E3E17900113, Slave, uptime=58858.90, priority=116, slot_id=1:3, idx=6, flag=0x64, in_sync=1

FPM20E3E17900217, Slave, uptime=58858.93, priority=117, slot_id=1:4, idx=7, flag=0x64, in_sync=1

...

In this command output, in_sync=1 means the module is synchronized with the primary FIM and in_sync=0
means the module is not synchronized.

Connect the M1 and M2 interfaces for HA heartbeat communication
HA heartbeat communication between FortiGate-7000s happens over the 10Gbit M1 and M2 interfaces of the
FIMs in each chassis. To set up HA heartbeat connections:

l Connect the M1 interfaces of all FIMs together using a switch.
l Connect the M2 interfaces of all FIMs together using another switch.

All of the M1 interfaces must be connected together with a switch and all of the M2 interfaces must be connected
together with another switch. Connecting M1 interfaces or M2 interfaces directly is not supported as each FIM
needs to communicate with all other FIMs.

Connect the M1 and M2 interfaces before enabling HA. Enabling HAmoves heartbeat
communication between the FIMs in the same chassis to the M1 and M2 interfaces.
So if these interfaces are not connected before you enable HA, FIMs in the same
chassis will not be able to communicate with each other.

Heartbeat packets are VLAN packets with VLAN ID 999 and ethertype 9890. The MTU value for the M1 and M2
interfaces is 1500.

You can use the following command to change the HA heartbeat packet VLAN ID and ethertype values if required
for your switches. By default the M1 and M2 interface heartbeat packets use the same VLAN IDs. The following
example changes the M1 VLAN ID to 4086 and the M2 VLAN ID to 4087.

config system ha
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set hbdev "1-M1" 50 "2-M1" 50 "1-M2" 50 "2-M2" 50
set hbdev-vlan-id 4086
set hbdev-second-vlan-id 4087
set ha-eth-type <eth-type>

end

For this configuration to work, you must change both VLAN IDs. You cannot use the default value of 999.

Recommended HA heartbeat interface configuration

If you are setting up an HA configuration of two FortiGate-7030Es installed in the same location, you can directly
connect their M1 interfaces and their M2 interfaces without using switches.

For redundancy, for other FortiGate-7000s, Fortinet recommends using separate switches for the M1 and M2
connections.These switches should be dedicated to HA heartbeat communication and not used for other traffic.

If you use the same switch for the M1 and M2 interfaces, separate the M1 and M2 traffic on the switch and set
the heartbeat traffic on the M1 and M2 interfaces to have different VLAN IDs.

If you don't set different VLAN IDs for the M1 and M2 heartbeat packets, you must enable q-in-q on the switch.

Example FortiGate-7000 switch configuration

The switch that you use for connecting HA heartbeat interfaces does not have to support IEEE 802.1ad (also
known as Q-in-Q, double-tagging). But the switch should be able to forward the double-tagged frames. Some
switches will strip out the inner tag and Fortinet recommends avoiding these switches. FortiSwitch D and E series
can correctly forward double-tagged frames.

This configuration is not required for FortiGate-7030E HA configurations if you have
set up direct connections between the HA heartbeat interfaces.

This example shows how to configure a FortiGate-7000 to use different VLAN IDs for the M1 and M2 HA
heartbeat interfaces and then how to configure two ports on a Cisco switch to allow HA heartbeat packets.

This example sets the native VLAN ID for both switch ports to 777. You can use any
VLAN ID as the native VLAN ID as long as the native VLAN ID is not the same as the
allowed VLAN ID.

1. On both FortiGate-7000s in the HA configuration, enter the following command to use different VLAN IDs for the
M1 and M2 interfaces. The command sets the M1 VLAN ID to 4086 and the M2 VLAN ID to 4087:
config system ha

set hbdev "1-M1" 50 "2-M1" 50 "1-M2" 50 "2-M2" 50
set hbdev-vlan-id 4086
set hbdev-second-vlan-id 4087

end
2. Use the get system ha status command to confirm the VLAN IDs.

get system ha status

...

HBDEV stats:

FG74E83E16000015(updated 1 seconds ago):

1-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=579602089/2290683/0/0,
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tx=215982465/761929/0/0, vlan-id=4086

2-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=577890866/2285570/0/0,

tx=215966839/761871/0/0, vlan-id=4086

1-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=579601846/2290682/0/0,

tx=215982465/761929/0/0, vlan-id=4087

2-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=577890651/2285569/0/0,

tx=215966811/761871/0/0, vlan-id=4087

FG74E83E16000016(updated 1 seconds ago):

1-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=598602425/2290687/0/0,

tx=196974887/761899/0/0, vlan-id=4086

2-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=596895956/2285588/0/0,

tx=196965052/761864/0/0, vlan-id=4086

1-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=598602154/2290686/0/0,

tx=196974915/761899/0/0, vlan-id=4087

2-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=596895685/2285587/0/0,

tx=196965080/761864/0/0, vlan-id=4087

...

3. Configure the Cisco switch port that connects the M1 interfaces to allow packets with a VLAN ID of 4086:
interface <name>

switchport mode trunk
switchport trunk native vlan 777
switchport trunk allowed vlan 4086

4. Configure the Cisco switch port that connects the M2 interfaces to allow packets with a VLAN ID of 4087:
interface <name>

switchport mode trunk
switchport trunk native vlan 777
switchport trunk allowed vlan 4087

Basic FortiGate-7000 HA configuration
Use the following steps to set up HA between two FortiGate-7000s. To configure HA, you assign a chassis ID (1
and 2) to each of the FortiGate-7000s. These IDs allow the FGCP to identify the chassis and do not influence
primary FortiGate-7000 selection. Before you start, determine which FortiGate-7000 should be chassis 1 and
which should be chassis 2.

1. Set up HA heartbeat communication as described in Connect the M1 and M2 interfaces for HA heartbeat
communication on page 730.

2. Log into the GUI or CLI of the FIM in slot 1 of the FortiGate-7000 that will become chassis 1.
Usually you would do this by connecting the management IP address of this FortiGate-7000.

3. Use the following CLI command to change the host name. This step is optional, but setting a host name makes
the FortiGate-7000 easier to identify after the cluster has formed.
config system global

set hostname 7K-Chassis-1
end

From the GUI you can configure the host name by going to System > Settings and changing the
Host name.

4. Enter the following command to configure basic HA settings for the chassis 1 FortiGate-7000:
config system ha

set group-id <id>
set group-name My-7K-Cluster
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set mode a-p
set hbdev 1-M1 50 1-M2 50 2-M1 50 2-M2 50
set chassis-id 1
set hbdev-vlan-id 4086
set hbdev-second-vlan-id 4087
set password <password>

end

From the GUI you can configure HA by going to System > HA. Set theMode to Active-Passive, set the
Group Name, add a Password, and set the Heartbeat Interface Priority for the heartbeat interfaces (1-
M1, 1-M2, 2-M1, and 2-M2). You must configure the chassis ID and group ID from the CLI.

5. Log into the chassis 2 FortiGate-7000 and configure its host name, for example:
config system global

set hostname 7K-Chassis-2
end

From the GUI you can configure the host name by going to System > Settings and changing the
Host name.

6. Enter the following command to configure basic HA settings. The configuration must be the same as the chassis 1
configuration, except for the chassis ID.
config system ha

set group-id <id>
set group-name My-7K-Cluster
set mode a-p
set hbdev 1-M1 50 1-M2 50 2-M1 50 2-M2 50
set chassis-id 2
set hbdev-vlan-id 4086
set hbdev-second-vlan-id 4087
set password <password>

end

From the GUI you can configure HA by going to System > HA. Set theMode to Active-Passive, set the
Group Name, add a Password, and set the Heartbeat Interface Priority for the heartbeat interfaces (1-
M1, 1-M2, 2-M1, and 2-M2). You must configure the chassis ID and group ID from the CLI.

Once you save your configuration changes, if the HA hearbeat interfaces are connected, the
FortiGate-7000s negotiate to establish a cluster. You may temporarily lose connectivity with the
FortiGate-7000s as the cluster negotiates and the FGCP changes the MAC addresses of the
FortiGate-7000 interfaces. To be able to reconnect sooner, you can update the ARP table of your
management PC by deleting the ARP table entry for the FortiGate (or just deleting all ARP table
entries). You may be able to delete the ARP table of your management PC from a command prompt
using a command similar to arp -d. When the cluster has completed negotiating, you can log into it
using the management IP address of the primary FortiGate-7000.

7. Log into the cluster and view the HA Status dashboard widget or enter the get system ha status command
to confirm that the cluster has formed and is operating normally.
If the cluster is operating normally, you can connect network equipment, add your configuration, and start
operating the cluster.

Verifying that the cluster is operating normally

You view the cluster status from the HA Status dashboard widget or by using the get system ha status
command.
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If the HA Status widget or the get system ha status command shows a cluster has not formed, check the
HA heartbeat connections. They should be configured as described in Connect the M1 and M2 interfaces for HA
heartbeat communication on page 730.

You should also review the HA configurations of the FortiGate-7000s. When checking the configurations, make
sure both FortiGate-7000s have the same HA configuration, including identical HA group IDs, group names,
passwords, and HA heartbeat VLAN IDs.

The following example FortiGate-7000 get system ha status output shows a FortiGate-7000 cluster that
is operating normally. The output shows which FortiGate-7000 has become the primary (master) FortiGate-7000
and how it was chosen. You can also see CPU and memory use data, HA heartbeat VLAN IDs, and so on.

get system ha status

Master selected using:

HA Health Status: OK

Model: FortiGate-7000E

Mode: HA A-P

Group: 7

Debug: 0

Cluster Uptime: 0 days 16:42:5

Cluster state change time: 2019-01-14 16:26:30

<2019/01/14 16:26:30> FG74E83E16000016 is selected as the master because it has more active switch blade.

<2019/01/14 16:26:12> FG74E83E16000016 is selected as the master because it's the only member in the

cluster.

ses_pickup: disable

override: disable

Configuration Status:

FG74E83E16000016(updated 4 seconds ago): in-sync

FG74E83E16000015(updated 0 seconds ago): in-sync

System Usage stats:

FG74E83E16000016(updated 4 seconds ago):

sessions=198, average-cpu-user/nice/system/idle=1%/0%/0%/97%, memory=5%

FG74E83E16000015(updated 0 seconds ago):

sessions=0, average-cpu-user/nice/system/idle=2%/0%/0%/96%, memory=6%

HBDEV stats:

FG74E83E16000016(updated 4 seconds ago):

1-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=227791977/902055/0/0,

tx=85589814/300318/0/0, vlan-id=4086

2-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=227119632/900048/0/0,

tx=85589814/300318/0/0, vlan-id=4086

1-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=227791977/902055/0/0,

tx=85589814/300318/0/0, vlan-id=4087

2-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=227119632/900048/0/0,

tx=85589814/300318/0/0, vlan-id=4087

FG74E83E16000015(updated 0 seconds ago):

1-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=0/0/0/0, tx=85067/331/0/0, vlan-id=4086

2-M1: physical/10000full, up, rx-bytes/packets/dropped/errors=947346/3022/0/0, tx=206768/804/0/0,

vlan-id=4086

1-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=0/0/0/0, tx=85067/331/0/0, vlan-id=4087

2-M2: physical/10000full, up, rx-bytes/packets/dropped/errors=946804/3020/0/0, tx=206768/804/0/0,

vlan-id=4087
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Master: 7K-Chassis-1 , FG74E83E16000016, cluster index = 0

Slave : 7K-Chassis-2    , FG74E83E16000015, cluster index = 1

number of vcluster: 1

vcluster 1: work 10.101.11.20

Master: FG74E83E16000016, operating cluster index = 0

Slave : FG74E83E16000015, operating cluster index = 1

Chassis Status: (Local chassis ID: 2)

Chassis ID 1: Slave Chassis

Slot ID 1: Master Slot

Slot ID 2: Slave Slot

Chassis ID 2: Master Chassis

Slot ID 1: Master Slot

Slot ID 2: Slave Slot

Setting up HA management connections
Fortinet recommends the following configurations for redundant management connections to a FortiGate-7000
HA configuration.

l Single management connections to each of the FIMs.
l Redundant management connections to each of the FIMs.

These management connections involve connecting the static redundant management interfaces (MGMT1 to
MGMT4) of each FIM in the HA configuration to one or more switches. You do not have to change the FortiGate-
7000 configuration to set up redundant management connections. However, specific switch configurations are
required for each of these configurations as described below.

LACP is not supported for the mgmt aggregate interface.

Setting up single management connections to each of the FIMs

The simplest way to provide redundant management connections to a FortiGate-7000 HA configuration involves
connecting the MGMT1 interface of each of the FIMs to four ports on a switch. On the switch you must add the
four switch ports to the same VLAN. Then connect the switch to your management network and allow traffic from
the VLAN to the management network.

A FortiGate-7030E HA configuration only has two FIMs so would only require two
switch ports.
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Example FortiGate-7000 HA redundant management connections

MGMT1

MGMT1

MGMT1

MGMT1

Switch

Port 1-4 added

to the same VLAN

Port 1

Port 2

Port 3

Port 4

Management

network

FIM in chassis 1, slot 1

FIM in chassis 1, slot 2

FIM in chassis 2, slot 1

FIM in chassis 2, slot 2

Setting up redundant management connections to each of the FIMs

You can enhance redundancy by setting up two redundant management connections to each FIM. To support
this configuration, on the switch you must create a port channel for each FIM interface. Create a total of four port
channels, one for each FIM and add each of the port channels to the same VLAN. Then connect the switch to
your management network and allow traffic from the VLAN to the management network.

If you use two switches, the VLAN should span across both switches.

A FortiGate-7030E HA configuration only has two FIMs so would only require two port
channels.

Example FortiGate-7000 HA redundant management connections with redundant connections to each FIM

MGMT1 and MGMT 2

MGMT1 and MGMT 2

MGMT1 and MGMT 2

MGMT1 and MGMT 2

Switch

Port channels

1 - 4  added

to the same

VLAN

Port channel 1

Switch Port 1 - 2

Management

network

FIM in chassis 1, slot 1

FIM in chassis 1, slot 2

FIM in chassis 2, slot 1

FIM in chassis 2, slot 2

Port channel 3

Switch Port 5 - 6

Port channel 4

Switch Port 7 - 8

Port channel 2

Switch Port 3 - 4
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Managing individual modules in HA mode
In some cases you may want to connect to an individual FIM or FPM in a specific FortiGate-7000. For example,
you may want to view the traffic being processed by the FPM in slot 3 of the FortiGate-7000 designated as
chassis 2. You can connect to the GUI or CLI of individual modules in the chassis using the system management
IP address with a special port number.

For example, if the system management IP address is 1.1.1.1 you can browse to https://1.1.1.1:44323 to
connect to the FPM in the FortiGate-7000 chassis 2 slot 3. The special port number (in this case 44323) is a
combination of the service port, chassis ID, and slot number. The following table lists the special ports for
common admin protocols:

FortiGate-7000 HA special administration port numbers

Chassis and Slot Number Slot Address HTTP
(80) HTTPS (443) Telnet

(23) SSH (22) SNMP (161)

Ch1 slot 5 FPM05 8005 44305 2305 2205 16105

Ch1 slot 3 FPM03 8005 44303 2303 2203 16103

Ch1 slot 1 FIM01 8003 44301 2301 2201 16101

Ch1 slot 2 FIM02 8002 44302 2302 2202 16102

Ch1 slot 4 FPM04 8004 44304 2304 2204 16104

Ch1 slot 6 FPM06 8006 44306 2306 2206 16106

Ch2 slot 5 FPM05 8005 44325 2325 2225 16125

Ch2 slot 3 FPM03 8005 44323 2323 2223 16123

Ch2 slot 1 FIM01 8003 44321 2321 2221 16121

Ch2 slot 2 FIM02 8002 44322 2322 2222 16122

Ch2 slot 4 FPM04 8004 44324 2324 2224 16124

Ch2 slot 6 FPM06 8006 44326 2326 2226 16126

For example:

l To connect to the GUI of the FPM in chassis 1 slot 3 using HTTPS you would browse to https://1.1.1.1:44313.

The formula for calculating the special port number is based on Chassis ID. CH1 =
Chassis ID1, CH2 = Chassis ID2. The formula is: service_port x 100 + (chassis_id – 1)
x 20 + slot_id.
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HA cluster firmware upgrades
All of the FIMs and FPMs in your FortiGate-7000 system run the same firmware image. You upgrade the
firmware from the primary FIM GUI or CLI just as you would any FortiGate product. During the upgrade process,
the firmware running on all of the FIMs and FPMs upgrades in one step. Firmware upgrades should be done
during a quiet time because traffic will briefly be interrupted during the upgrade process. The entire firmware
upgrade will take a few minutes depending on the number of FIMs and FPMs in your FortiGate-7000 system.
Also, some firmware upgrades may take longer depending on other factors such as the size of the configuration
and whether a DP processor firmware upgrade is included.

Before beginning a firmware upgrade, Fortinet recommends the following:

l Review the latest release notes for the firmware version that you are upgrading to.
l Verify the recommended upgrade path as documented in the release notes.
l Backup your FortiGate-7000 configuration.

Fortinet recommends that you review the services provided by your FortiGate-7000
before a firmware upgrade and then again after the upgrade to make sure everything
continues to operate normally. For example, you might want to verify that you can
successfully access an important server used by your organization before the upgrade
and make sure after the upgrade that you can still reach the server and that
performance is comparable. You could also take a snapshot of key performance
indicators (number of sessions, CPU usage, and memory usage) before the upgrade
and verify that you see comparable performance after the upgrade.

Enabling uninterruptable-upgrade

Fortinet recommends upgrading your FortiGate-7000 HA configuration firmware with uninterruptable-
upgrade enabled. With uninterruptable-upgrade enabled, the FortiGate-7000 HA configuration goes
through a multi-step process to upgrade the firmware of all components in the configuration. Since many
components are involved, the entire upgrade process may take a few minutes. It all happens automatically and
should cause only minor traffic disruptions. Because of the possible disruptions, you should upgrade HA cluster
firmware when traffic is low or during a maintenance period.

Use the following command to enable uninterruptable-upgrade:

config system ha
set uninterruptable-upgrade enable

end

The following steps happen in the background when upgrading the firmware running on a FortiGate-7000 HA
cluster with uninterruptable-upgrade enabled.

l The firmware upgrade downloads to the primary (master) FortiGate-7000.
l The primary FortiGate-7000 sends a copy of the firmware upgrade file to the backup (slave) FortiGate-7000.
l The backup FortiGate-7000 upgrades its firmware, restarts, and rejoins the cluster.
l The primary FortiGate-7000 verifies that all members of the backup FortiGate-7000 can process traffic. The

firmware upgrade will not proceed until all of the backup FortiGate-7000 components are operating.
l The primary FortiGate-7000 then sends a switchover command and the backup FortiGate-7000 becomes the

primary FortiGate-7000.
l The new primary FortiGate-7000 sends gratuitous ARP packets to inform attached network devices to send packets

to the new primary FortiGate-7000.
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l Traffic switches over to the new primary FortiGate-7000.
l The original primary FortiGate-7000 upgrades its firmware, restarts, and rejoins the cluster as the backup

FortiGate-7000.

The amount of time this process takes and the probability of minor traffic disruptions depends on the number of
modules in your FortiGate-7000 and on traffic load conditions, the network configuration, and how quickly the
gratuitous ARP packets update network devices.

Verifying that a firmware upgrade is successful

After a FortiGate-7000 cluster firmware upgrade, you should verify that all of the FIMs and FPMs have been
successfully upgraded to the new firmware version.

After the firmware upgrade appears to be complete:

1. Log into the primary FIM and verify that it is running the expected firmware version.
You can verify the firmware version running on the primary FIM from the dashboard or by using the get system
status command.

2. Log into the other FIMs and the FPMs, and in the same way confirm that they are also running the expected
firmware version.
You can log into individual FIMs or FPMs using the system management IP address and the special port number
for each module. For example, https://192.268.1.99:44303 connects to the module in slot 3. The special port
number (in this case 44303) is a combination of the service port (for HTTPS the service port is 443) and the slot
number (in this example, 03). For more information, see Managing individual modules in HA mode on page 737.
If you are using a management module console port to connect to the primary FIM CLI you can use Ctrl-T to
switch between the CLIs of each of the modules.

3. If one or more of the FIMs or FPMs are not running the correct firmware version, use the procedures described in
Installing firmware on individual FIMs and FPMs on page 715 to upgrade these FIMs or FPMs.

Distributed clustering
FortiGate-7000 HA supports separating the FortiGate-7000s in different physical locations. Distributed FortiGate-
7000 HA clustering (or geographically distributed FortiGate-7000 HA or geo clustering) can involve two FortiGate-
7000s in different rooms in the same building, different buildings in the same location, or even different
geographical sites such as different cities, countries or continents.

Just like any FortiGate-7000 HA configuration, distributed FortiGate-7000 HA requires heartbeat communication
between the FortiGate-7000s over the M1 and M2 interfaces. In a distributed FortiGate-7000 HA configuration
this heartbeat communication can take place over the Internet or over other transmission methods including
satellite linkups.

Most Data Center Interconnect (DCI) or MPLS-based solutions that support layer 2 extensions and VLAN tags
between the remote data centers should also support HA heartbeat communication between the FortiGates in
the distributed locations. Using VLANs and switches in promiscuous mode to pass all traffic between the
locations can also be helpful.

You cannot change HA heartbeat IP addresses, so the heartbeat interfaces have to be able to communication
over the same subnet.

The M1 and M2 interface traffic must be separated. You can do this by using separate channels for each interface
or by configuring the M1 and M2 interfaces to use different VLANs.
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Example FortiGate-7000 distributed clustering configuration

Because of the possible distance between sites, it may take a relatively long time for heartbeat packets to be
transmitted between the FortiGate-7000s. This could lead to a split brain scenario. To avoid a split brain scenario
you can modify heartbeat timing so that the cluster expects extra time between heartbeat packets. As a general
rule, set the heartbeat failover time (hb-interval) to be longer than the max latency or round trip time (RTT).
You could also increase the hb-lost-threshold to tolerate losing heartbeat packets if the network
connection is less reliable.

In addition you could use different link paths for heartbeat packets to optimize HA heartbeat communication. You
could also configure QoS on the links used for HA heartbeat traffic to make sure heartbeat communication has
the highest priority.

Modifying heartbeat timing
If the FortiGate-7000s in the HA cluster do not receive heartbeat packets on time, the FortiGate-7000s in the HA
configuration may each determine that the other FortiGate-7000 has failed. HA heartbeat packets may not be
sent on time because of network issues. For example, if the M1 and M2 communications links between the
FortiGate-7000s become too busy to handle the heartbeat traffic. Also, in a distributed clustering configuration
the round trip time (RTT) between the FortiGate-7000s may be longer the expected time between heartbeat
packets.

In addition, if the FortiGate-7000s becomes excessively busy, they may delay sending heartbeat packets.
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Even with these delays, the FortiGate-7000 HA cluster can continue to function normally as long as the
HA heartbeat configuration supports longer delays between heartbeat packets and more missed heartbeat
packets.

You can use the following commands to configure heartbeat timing:

config system ha
set hb-interval <interval_integer>
set hb-lost-threshold <threshold_integer>
set hello-holddown <holddown_integer>

end

Changing the heartbeat interval

The heartbeat interval is the time between sending HA heartbeat packets. The heartbeat interval range is 1 to 20
(100*ms). The heartbeat interval default is 2 (200 ms).

A heartbeat interval of 2 means the time between heartbeat packets is 200 ms. Changing the heartbeat interval
to 5 changes the time between heartbeat packets to 500 ms (5 * 100ms = 500ms).

Use the following CLI command to increase the heartbeat interval to 10:

config system ha
set hb-interval 10

end

Changing the lost heartbeat threshold

The lost heartbeat threshold is the number of consecutive heartbeat packets that a FortiGate does not receive
before assuming that a failure has occurred. The default value of 6mean that if a FortiGate-7000 does not receive
6 heartbeat packets it determines that the other FortiGate-7000 in the cluster has failed. The range is 1 to 60
packets.

The lower the hb-lost-threshold, the faster a FortiGate-7000 HA configuration responds when a failure
occurs. However, sometimes heartbeat packets may not be received because the other FortiGate-7000 is very
busy or because of network conditions. This can lead to a false positive failure detection. To reduce these false
positives you can increase the hb-lost-threshold.

Use the following command to increase the lost heartbeat threshold to 12:

config system ha
set hb-lost-threshold 12

end

Adjusting the heartbeat interval and lost heartbeat threshold

The heartbeat interval combines with the lost heartbeat threshold to set how long a FortiGate-7000 waits before
assuming that the other FortiGate-7000 has failed and is no longer sending heartbeat packets. By default, if a
FortiGate-7000 does not receive a heartbeat packet from a cluster unit for 6 * 200 = 1200 milliseconds or 1.2
seconds the FortiGate-7000 assumes that the other FortiGate-7000 has failed.

You can increase both the heartbeat interval and the lost heartbeat threshold to reduce false positives. For
example, increasing the heartbeat interval to 20 and the lost heartbeat threshold to 30 means a failure will be
assumed if no heartbeat packets are received after 30 * 2000 milliseconds = 60,000 milliseconds, or 60 seconds.

Use the following command to increase the heartbeat interval to 20 and the lost heartbeat threshold to 30:

config system ha
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set hb-lost-threshold 20
set hb-interval 30

end

Changing the time to wait in the hello state

The hello state hold-down time is the number of seconds that a FortiGate-7000 waits before changing from hello
state to work state. After a failure or when starting up, FortiGate-7000s in HAmode operate in the hello state to
send and receive heartbeat packets to find each other and form a cluster. A FortiGate-7000 should change from
the hello state to work state after it finds the FortiGate-7000 to form a cluster with. If for some reason the
FortiGate-7000s cannot find each other during the hello state both FortiGate-7000s may assume that the other
one has failed and each could form separate clusters of one FortiGate-7000. The FortiGate-7000s could
eventually find each other and negotiate to form a cluster, possibly causing a network interruption as they re-
negotiate.

One reason for a delay of the FortiGate-7000s finding each other could be the FortiGate-7000s are located at
different sites or for some other reason communication is delayed between the heartbeat interfaces. If you find
that your FortiGate-7000s leave the hello state before finding each other you can increase the time that they wait
in the hello state. The hello state hold-down time range is 5 to 300 seconds. The hello state hold-down time
default is 20 seconds.

Use the following command to increase the time to wait in the hello state to 1 minute (60 seconds):

config system ha
set hello-holddown 60

end

Session failover (session-pickup)
Session failover means that after a failover, communications sessions resume on the new primary FortiGate-
7000 with minimal or no interruption. Two categories of sessions need to be resumed after a failover:

l Sessions passing through the cluster
l Sessions terminated by the cluster

Session failover (also called session-pickup) is not enabled by default for FortiGate-7000 HA. If sessions pickup is
enabled, while the FortiGate-7000 HA cluster is operating the primary FortiGate-7000 informs the backup
FortiGate-7000 of changes to the primary FortiGate-7000 connection and state tables for TCP and UDP sessions
passing through the cluster, keeping the backup FortiGate-7000 up-to-date with the traffic currently being
processed by the cluster.

After a failover the new primary FortiGate-7000 recognizes open sessions that were being handled by the cluster.
The sessions continue to be processed by the new primary FortiGate-7000 and are handled according to their last
known state.

Session-pickup has some limitations. For example, session failover is not supported
for sessions being scanned by proxy-based security profiles. Session failover is
supported for sessions being scanned by flow-based security profiles; however, flow-
based sessions that fail over are not inspected after they fail over.

Sessions terminated by the cluster include management sessions (such as HTTPS connections to the FortiGate
GUI or SSH connection to the CLI as well as SNMP and logging and so on). Also included in this category are
IPsec VPN, SSL VPN, sessions terminated by the cluster, and explicit proxy sessions. In general, whether or not
session-pickup is enabled, these sessions do not failover and have to be restarted.
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Enabling session pickup for TCP and UDP

To enable session-pickup, from the CLI enter:

config system ha
set session-pickup enable

end

When session-pickup is enabled, sessions in the primary FortiGate-7000 TCP and UDP session tables are
synchronized to the backup FortiGate-7000. As soon as a new TCP or UDP session is added to the primary
FortiGate-7000 session table, that session is synchronized to the backup FortiGate-7000. This synchronization
happens as quickly as possible to keep the session tables synchronized.

If the primary FortiGate-7000 fails, the new primary FortiGate-7000 uses its synchronized session tables to
resume all TCP and UDP sessions that were being processed by the former primary FortiGate-7000 with only
minimal interruption. Under ideal conditions all TCP and UDP sessions should be resumed. This is not
guaranteed though and under less than ideal conditions some sessions may need to be restarted.

If session pickup is disabled

If you disable session pickup, the FortiGate-7000 HA cluster does not keep track of sessions and after a failover,
active sessions have to be restarted or resumed. Most session can be resumed as a normal result of how TCP
and UDP resumes communication after any routine network interruption.

The session-pickup setting does not affect session failover for sessions terminated by
the cluster.

If you do not require session failover protection, leaving session pickup disabled may reduce CPU usage and
reduce HA heartbeat network bandwidth usage. Also if your FortiGate-7000 HA cluster is mainly being used for
traffic that is not synchronized (for example, for proxy-based security profile processing) enabling session pickup
is not recommended since most sessions will not be failed over anyway.

Primary FortiGate-7000 selection
Once two FortiGate-7000s recognize that they can form a cluster, they negotiate to select a primary FortiGate-
7000. Primary FortiGate-7000 selection occurs automatically based on the selection criteria shown in the diagram
below. After the cluster selects the primary FortiGate-7000, the other FortiGate-7000 becomes the backup.

Negotiation and primary FortiGate-7000 selection also takes place if the one of the criteria for selecting the
primary FortiGate-7000 changes. For example, an interface can become disconnected or an FIM can fail. After
this happens, the cluster can renegotiate to select a new primary FortiGate-7000 using the same selection
criteria.
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If there are no FIM failures and if you haven't configured any settings to influence primary FortiGate-7000
selection, the FortiGate-7000 with the highest serial number becomes the primary FortiGate-7000.

This section highlights some aspects of primary FortiGate-7000 selection. For more details about how this works,
see Primary unit selection on page 1744.
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Age and primary FortiGate-7000 selection

Age (or uptime) is also a factor in primary FortiGate-7000 selection. Normally when two FortiGate-7000s start,
their uptimes are similar and do not affect primary FortiGate-7000 selection. However, during operation, if one of
the FortiGate-7000s goes down the other will have a much higher age or uptime and will be selected as the
primary FortiGate-7000 before checking priority and serial number.

In some cases, age differences can result in the wrong FortiGate-7000 becoming the primary FortiGate-7000.
For example, if the FortiGate-7000 set to a high priority reboots, it will have a lower age than other FortiGate-
7000 when it rejoins the cluster. Since age takes precedence over priority it will become the backup FortiGate-
7000 when it rejoins the cluster.

One way to resolve this issue is to reboot both FortiGate-7000s in the cluster at the same time to reset the age of
both FortiGate-7000s. However, doing this would disrupt traffic. Instead you can use the following command to
reset the age of one the primary FortiGate-7000 to zero.

diagnose sys ha reset-uptime

The primary FortiGate-7000 now has the lowest age and the other FortiGate-7000 will have the highest age and
can then become the primary FortiGate-7000.

The diagnose sys ha reset-uptime command should only be used as a
temporary solution. You should reboot the FortiGate-7000s during a maintenance
window to permanently bring their ages back together.

Device priority and primary FortiGate-7000 selection

In some situations you may want to select a FortiGate-7000 to always become the primary FortiGate-7000. You
can do this by setting its device priority higher. You can change the device priority of an FIM from the System >
HA GUI page or by using the following command:

config system ha
set priority <number>

end

The default priority is 128.

During negotiation, the FortiGate-7000 with the highest device priority becomes the primary FortiGate-7000.

Override and primary FortiGate-7000 selection

You can enable override to select a FortiGate-7000 to always becomes the primary FortiGate-7000. Enabling
override changes how primary select works. For details, see Override and primary FortiGate-7000 selection on
page 1.

FIM failure and primary FortiGate-7000 selection

If an FIM fails, the FortiGate-7000 cluster negotiates to select a new Primary FortiGate-7000 and the FortiGate-
7000 with the most operating FIMs becomes the primary FortiGate-7000.

You can also configure board failover tolerance to control how a FortiGate-7000 cluster responds to an FIM
failure.

config system ha
set board-failover-tolerance <tolerance>

end
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Where <tollerance> can be 0 or 1. A tolerance of 0 (the default) means that if a single FIM fails in the primary
FortiGate-7000, a failover occurs and the FortiGate-7000 with the fewest failed FIMs becomes the new primary
FortiGate-7000. A failover tolerance of 1 means that both FIMs must fail before a failover occurs.

Verifying primary FortiGate-7000 selection

You can use the get system ha status command to verify which FortiGate-7000 has become the primary
FortiGate-7000. The command output shows which FortiGate-7000 is currently operating as the primary
FortiGate-7000. The following command output excerpt shows that the FortiGate-7000 labeled as chassis 2 has
become the primary (master) FortiGate-7000:

get system ha status
Master selected using:
HA Health Status: OK
Model: FortiGate-7000E
Mode: HA A-P
Group: 7
Debug: 0
Cluster Uptime: 0 days 16:42:5
...
Master: CH16 , FG74E83E16000016, cluster index = 0
Slave : FG74E83E16000015, FG74E83E16000015, cluster index = 1
number of vcluster: 1
vcluster 1: work 10.101.11.20
Master: FG74E83E16000016, operating cluster index = 0
Slave : FG74E83E16000015, operating cluster index = 1
Chassis Status: (Local chassis ID: 2)

Chassis ID 1: Slave Chassis
Slot ID 1: Master Slot
Slot ID 2: Slave Slot

Chassis ID 2: Master Chassis
Slot ID 1: Master Slot
Slot ID 2: Slave Slot

Primary FortiGate-7000 selection and override
When configuring FortiGate-7000 HA, if you want one of the FortGate-7000s to always become the primary
FortiGate-7000 you can enable override on that FortiGate-7000. For override to be effective, you must
also set the device priority highest on this FortiGate-7000.

To enable override and increase device priority:

config system ha
set override enable
set priority 200

end

The FortiGate-7000 with override enabled and the highest device priority always becomes the primary FortiGate-
7000.

In most cases, with override enabled the cluster will negotiate more often. For example, with override enabled it
is more likely that changes to the backup FortiGate-7000 may cause the cluster to negotiate. More frequent
negotiation can lead to more traffic disruptions.
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This section highlights some aspects of enabling override. For more details about how this works, see HA
override on page 1752.

Enabling override changes primary FortiGate-7000 selection

Enabling override changes the order of primary FortiGate-7000 selection. As shown below, if override is
enabled, primary FortiGate-7000 selection considers device priority before age and serial number. This means
that if you set the device priority higher on one FortiGate-7000, with override enabled this FortiGate-7000
becomes the primary FortiGate-7000 even if its age and serial number are lower.

Similar to when override is disabled, when override is enabled primary FortiGate-7000 selection checks for
operating FIMs and connected monitored interfaces first. So if interface monitoring is enabled, the FortiGate-
7000 with the most disconnected monitored interfaces cannot become the primary FortiGate-7000, even if this
FortiGate-7000 has the highest device priority.
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Link failover (port monitoring or interface monitoring)
Link failover means that if a monitored interface fails, the FortiGate-7000 cluster reorganizes to reestablish a link
to the network that the monitored interface was connected to and to continue operating with minimal or no
disruption of network traffic.
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You configure monitored interfaces (also called interface monitoring or port monitoring) by selecting FIM front
panel interfaces to monitor as part of the HA configuration.

You can monitor up to 64 interfaces. The FGCP synchronizes the interface monitoring configurations to both
FortiGate-7000s in the cluster.

The interfaces that you can monitor appear on the HAGUI pageMonitor Interfaces list. You can monitor any
FIM interfaces including redundant interfaces and 802.3ad aggregate interfaces.

You cannot monitor the following types of interfaces (you cannot select these types of interfaces on the Monitor
Interfaces list):

l VLAN subinterfaces.
l IPsec VPN interfaces.
l Individual physical interfaces that have been added to a redundant or 802.3ad aggregate interface.

You should only monitor interfaces that are connected to networks, because a failover may
occur if you monitor an unconnected interface. For this reason, you should also wait until
your FortiGate-7000 HA setup has been configured and connected and is operating as
expected before enabling interface monitoring.

To enable interface monitoring

From the GUI, go to System > HA and add interfaces to theMonitor Interfaces list.

From the CLI, enter the following command to monitor the 1-B1/2 and 2-C1/10 interfaces:

config system ha
set monitor 1-B1/2 2-C1/10

end

With interface monitoring enabled, during FortiGate-7000 cluster operation, the cluster monitors each FIM in the
cluster to determine if the monitored interfaces are operating and connected. Each FIM can detect a failure of its
network interface hardware.

FIMs cannot determine if the switches that its interfaces are connected to are still
connected to networks. However, you can use remote IPmonitoring to make sure that the
cluster unit can connect to downstream network devices. See Remote link failover on page
750.

If a monitored interface on the primary FortiGate-7000 fails

Because the primary FortiGate-7000 receives all traffic processed by the cluster, a FortiGate-7000 cluster can
only process traffic from a network if the primary FortiGate-7000 can connect to it. So, if the link between a
network and the primary FortiGate-7000 fails, to maintain communication with this network, the cluster must set
the FortiGate-7000 that is still connected to this network to become the primary FortiGate-7000. Unless another
link failure has occurred, the new primary FortiGate-7000 will have an active link to the network and will be able to
maintain communication with it.

To support link failover, the FortiGate-7000s store link state information for all monitored interfaces in a link state
database. If one of the monitored interfaces on one of the FortiGate-7000s becomes disconnected or fails, this
information is immediately shared with the other FortiGate-7000 in the cluster.

If a monitored interface on the primary FortGate-7000 fails, the cluster renegotiates to select the primary
FortiGate-7000 using the process described in Primary FortiGate-7000 selection on page 743. Because the
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FortGate-7000 with the failed monitored interface has the lowest monitor priority, the other FortiGate-7000
becomes the primary FortiGate-7000. The new primary FortiGate-7000 should have fewer link failures.

If a monitored interface on the backup FortiGate-7000 fails

If a monitored interface on a the backup FortiGate-7000 fails, this information is shared with the primary
FortiGate-7000. The cluster does not renegotiate. The backup FortiGate-7000 with the failed monitored interface
continues to function in the cluster.

Remote link failover
Remote link failover (also called remote IPmonitoring) is similar to interface monitoring and link health
monitoring (also known as dead gateway detection). Remote IPmonitoring uses link health monitors to test
connectivity between the primary FortiGate-7000 and remote network devices such as a downstream router.
Remote IPmonitoring causes a failover if one or more of these remote IP addresses does not respond to link
health checking.

In the simplified example topology shown above, the switch connected directly to the primary FortiGate-7000 is
operating normally but the link on the other side of the switches fails. As a result, traffic can no longer flow
between the primary ForitiGate-7000 and the Internet.
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This section highlights some aspects of FortiGate-7000 remote IPmonitoring. For more details about how this
works, see Remote link failover (remote IPmonitoring) on page 1943.

Configuring remote IP monitoring

Enter the following command to enable HA remote IPmonitoring on the 1-B1/1 interface:

config system ha
set pingserver-monitor-interface 1-B1/1
set pingserver-failover-threshold 5
set pingserver-flip-timeout 120

end

Keep the pingserver-failover-threshold set to the default value of 5. This means a failover occurs if
the link health monitor doesn’t get a response after 5 attempts.

Set the pingserver-flip-timeout set to 120 minutes. After a failover, if HA remote IPmonitoring on the
new primary unit also causes a failover, the flip timeout prevents the failover from occurring until the timer runs
out. Setting the pingserver-flip-timeout to 120 means that remote IPmonitoring can only cause a
failover every 120 minutes. This flip timeout is required to prevent repeating failovers if remote IPmonitoring
causes a failover from all cluster units because none of the cluster units can connect to the monitored IP
addresses.

Enter the following command to add a link health monitor for the 1-B1/1interface and to set HA remote IP
monitoring priority for this link health monitor.

config system link-monitor
edit ha-link-monitor

set server 192.168.20.20
set srcintf port2
set ha-priority 1
set interval 5
set failtime 2

end

The detectserver option sets the remote IP address to monitor to 192.168.20.20.

Leave the ha-priority keyword set to the default value of 1. You only need to change this priority if you
change the HA pingserver-failover-threshold. The ha-priority setting is not synchronized
among the FortiGate-7000s in the HA configuration.

The ha-priority setting is not synchronized. So if you want to change the ha-
priority setting you must change it separately on each FortiGate-7000. Otherwise it will
remain set to the default value of 1.

Use the interval option to set the time between link health checks and use the failtime keyword to set the
number of times that a health check can fail before a failure is detected (the failover threshold). The example
reduces the failover threshold to 2 but keeps the health check interval at the default value of 5.

FortiGate-7000 v5.6.7 special features and limitations

This section describes special features and limitations for FortiGate-7000 v5.6.7.
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Managing the FortiGate-7000
Management is only possible through the MGMT1 to MGMT4 front panel management interfaces. By default the
MGMT1 to MGMT4 interfaces of the FIMs in slot 1 and slot 2 are in a single static aggregate interface named
mgmt with IP address 192.168.1.99. You manage the FortiGate-7000 by connecting any one of these eight
interfaces to your network, opening a web browser and browsing to the management IP address. For a factory
default configuration, browse to https://192.168.1.99.

The FortiGate-7030E has one FIM and the MGMT1 to MGMT4 interfaces of that
module are the only interfaces in the aggregate interface.

Default management VDOM

By default the FortiGate-7000 configuration includes a management VDOM named mgmt-vdom. For the
FortiGate-7000 system to operate normally you should not change the configuration of this VDOM and this
VDOM should always be the management VDOM. You should also not add or remove interfaces from this
VDOM.

You have full control over the configurations of other FortiGate-7000 VDOMs.

Maximum number of LAGs
FortiGate-7000 systems support up to 16 link aggregation groups (LAGs). This includes both normal link
aggregation groups and redundant interfaces and including the redundant interface that contains the M1 to M4
management interfaces.

Firewall
TCP sessions with NAT enabled that are expected to be idle for more than the distributed processing normal TCP
timer (which is 3605 seconds) should only be distributed to the master FPM using a flow rule. You can configure
the distributed normal TCP timer using the following command:

config system global
set dp-tcp-normal-timer <timer>

end

UDP sessions with NAT enabled that are expected to be idle for more than the distributed processing normal UDP
timer should only be distributed to the primary FPM using a flow rule.

IP multicast
IPv4 and IPv6 Multicast traffic is only sent to the primary FPM (usually the FPM in slot 3). This is controlled by the
following configuration:

config load-balance flow-rule
edit 18

set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 224.0.0.0 240.0.0.0
set protocol any
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set action forward
set forward-slot master
set priority 5
set comment "ipv4 multicast"

next
edit 19

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ff00::/8
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv6 multicast"

end

High availability
Only the M1 and M2 interfaces are used for the HA heartbeat communication. For information on how to set up
HA heartbeat communication using the M1 and M2 interfaces, see Connect the M1 and M2 interfaces for HA
heartbeat communication on page 730

The following FortiOS HA features are not supported or are supported differently by FortiGate-7000 v5.6.7:

l Active-active HA is not supported.
l The range for the HA group-id is 0 to 31.
l Failover logic for FortiGate-7000 HA is not the same as FGCP for other FortiGate clusters.
l HA heartbeat configuration is specific to FortiGate-7000 systems and differs from standard HA.
l FortiGate Session Life Support Protocol (FGSP) HA (also called standalone session synchronization) is not

supported.
l FortiGate-7000 HA does not support the route-ttl, route-wait, and route-hold options for tuning route

synchronization between FortiGate-7000s.

Shelf manager module
It is not possible to access SMM CLI using Telnet or SSH. Only console access is supported using the chassis
front panel console ports as described in the FortiGate-7000 system guide.

For monitoring purpose, IPMI over IP is supported on SMM Ethernet ports. See your FortiGate-7000 system
guide for details.

FortiOS features not supported by FortiGate-7000 v5.6.7
The following mainstream FortiOS 5.6.7 features are not supported by the FortiGate-7000 v5.6.7:

l Hardware switch
l Switch controller
l WiFi controller
l WAN load balancing (SD-WAN)
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l IPv4 over IPv6, IPv6 over IPv4, IPv6 over IPv6 features
l GRE tunneling is only supported after creating a load balance flow rule, for example:

config load-balance flow-rule
edit 0

set status enable
set vlan 0
set ether-type ip
set protocol gre
set action forward
set forward-slot master
set priority 3

end

l Hard disk features including, WAN optimization, web caching, explicit proxy content caching, disk logging, and GUI-
based packet sniffing.

l The FortiGate-7000 platform only supports quarantining files to FortiAnalyzer.
l Log messages should be sent only using the management aggregate interface

IPsec VPN tunnels terminated by the FortiGate-7000
For a list of new FortiOS 5.6 FortiGate-7000 IPsec VPN features and a list of IPsec VPN features not supported
by FortiOS 5.6 FortiGate-7000 IPsec VPN, see New IPsec VPN features on page 722.

SSL VPN
Sending all SSL VPN sessions to the primary FPM is recommended. You can do this by:

l Creating a flow rule that sends all sessions that use the SSL VPN destination port and IP address to the primary
FPM.

l Creating flow rules that send all sessions that use the SSL VPN IP pool addresses to the primary FPM.

For more information about FortiGate-7000 SSL VPN support, see SSL VPN load balancing on page 705.

Traffic shaping and DDoS policies
Each FPM applies traffic shaping and DDoS quotas independently. Because of load-balancing, this may allow
more traffic than expected.

Sniffer mode (one-arm sniffer)
One-arm sniffer mode is only supported after creating a load balance flow rule to direct sniffer traffic to a specific
FPM.

FortiGuard web filtering
All FortiGuard rating queries are sent through management aggregate interface from the management VDOM
(named mgmt).

Log messages include a slot field
An additional "slot" field has been added to log messages to identify the FPM that generated the log.
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FortiOS Carrier
You have to apply a FortiOS Carrier license separately to each FIM and FPM to license a FortiGate-7000 for
FortiOS Carrier.

Special notice for new deployment connectivity testing
Only the primary FPM can successfully ping external IP addresses. During a new deployment, while performing
connectivity testing from the Fortigate-7000, make sure to run execute ping tests from the primary FPM CLI.

Dedicated management interfaces not supported
The FortiGate-7000 does not support configuring dedicated management interfaces using the config system
dedicated-mgmt command. Instead you can enter the following to configure an interface to be dedicated to
management:

config system interface
edit <interface-name>

set dedicated-to management
end

FortiGate-7000 v5.6.6 special features and limitations

This section describes special features and limitations for FortiGate-7000 v5.6.6.

Managing the FortiGate-7000
Management is only possible through the MGMT1 to MGMT4 front panel management interfaces. By default the
MGMT1 to MGMT4 interfaces of the FIMs in slot 1 and slot 2 are in a single static aggregate interface named
mgmt with IP address 192.168.1.99. You manage the FortiGate-7000 by connecting any one of these eight
interfaces to your network, opening a web browser and browsing to the management IP address. For a factory
default configuration, browse to https://192.168.1.99.

The FortiGate-7030E has one FIM and the MGMT1 to MGMT4 interfaces of that
module are the only interfaces in the aggregate interface.

Default management VDOM

By default the FortiGate-7000 configuration includes a management VDOM named mgmt-vdom. For the
FortiGate-7000 system to operate normally you should not change the configuration of this VDOM and this
VDOM should always be the management VDOM. You should also not add or remove interfaces from this
VDOM.

You have full control over the configurations of other FortiGate-7000 VDOMs.
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Maximum number of LAGs
FortiGate-7000 systems support up to 16 link aggregation groups (LAGs). This includes both normal link
aggregation groups and redundant interfaces and including the redundant interface that contains the M1 to M4
management interfaces.

Firewall
TCP sessions with NAT enabled that are expected to be idle for more than the distributed processing normal TCP
timer (which is 3605 seconds) should only be distributed to the master FPM using a flow rule. You can configure
the distributed normal TCP timer using the following command:

config system global
set dp-tcp-normal-timer <timer>

end

UDP sessions with NAT enabled that are expected to be idle for more than the distributed processing normal UDP
timer should only be distributed to the primary FPM using a flow rule.

IP multicast
IPv4 and IPv6 Multicast traffic is only sent to the primary FPM (usually the FPM in slot 3). This is controlled by the
following configuration:

config load-balance flow-rule
edit 18

set status enable
set vlan 0
set ether-type ipv4
set src-addr-ipv4 0.0.0.0 0.0.0.0
set dst-addr-ipv4 224.0.0.0 240.0.0.0
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv4 multicast"

next
edit 19

set status enable
set vlan 0
set ether-type ipv6
set src-addr-ipv6 ::/0
set dst-addr-ipv6 ff00::/8
set protocol any
set action forward
set forward-slot master
set priority 5
set comment "ipv6 multicast"

end

High availability
Only the M1 and M2 interfaces are used for the HA heartbeat communication. For information on how to set up
HA heartbeat communication using the M1 and M2 interfaces, see Connect the M1 and M2 interfaces for HA
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heartbeat communication on page 730

The following FortiOS HA features are not supported or are supported differently by FortiGate-7000 v5.6.6:

l Active-active HA is not supported.
l The range for the HA group-id is 0 to 14.
l Failover logic for FortiGate-7000 HA is not the same as FGCP for other FortiGate clusters.
l HA heartbeat configuration is specific to FortiGate-7000 systems and differs from standard HA.
l FortiGate Session Life Support Protocol (FGSP) HA (also called standalone session synchronization) is not

supported.
l FortiGate-7000 HA does not support the route-ttl, route-wait, and route-hold options for tuning route

synchronization between FortiGate-7000s.

Shelf manager module
It is not possible to access SMM CLI using Telnet or SSH. Only console access is supported using the chassis
front panel console ports as described in the FortiGate-7000 system guide.

For monitoring purpose, IPMI over IP is supported on SMM Ethernet ports. See your FortiGate-7000 system
guide for details.

FortiOS features not supported by FortiGate-7000 v5.6.6
The following mainstream FortiOS 5.6.6 features are not supported by the FortiGate-7000 v5.6.6:

l Hardware switch
l Switch controller
l WiFi controller
l WAN load balancing (SD-WAN)
l IPv4 over IPv6, IPv6 over IPv4, IPv6 over IPv6 features
l GRE tunneling is only supported after creating a load balance flow rule, for example:

config load-balance flow-rule
edit 0

set status enable
set vlan 0
set ether-type ip
set protocol gre
set action forward
set forward-slot master
set priority 3

end

l Hard disk features including, WAN optimization, web caching, explicit proxy content caching, disk logging, and GUI-
based packet sniffing.

l The FortiGate-7000 platform only supports quarantining files to FortiAnalyzer.
l Log messages should be sent only using the management aggregate interface

IPsec VPN tunnels terminated by the FortiGate-7000
For a list of new FortiOS 5.6.6 FortiGate-7000 IPsec VPN features and a list of IPsec VPN features not supported
by FortiOS 5.6.6 FortiGate-7000 IPsec VPN, see New IPsec VPN features on page 722.
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SSL VPN
Sending all SSL VPN sessions to the primary FPM is recommended. You can do this by:

l Creating a flow rule that sends all sessions that use the SSL VPN destination port and IP address to the primary
FPM.

l Creating flow rules that send all sessions that use the SSL VPN IP pool addresses to the primary FPM.

For more information about FortiGate-7000 SSL VPN support, see SSL VPN load balancing on page 705.

Traffic shaping and DDoS policies
Each FPM applies traffic shaping and DDoS quotas independently. Because of load-balancing, this may allow
more traffic than expected.

Sniffer mode (one-arm sniffer)
One-arm sniffer mode is only supported after creating a load balance flow rule to direct sniffer traffic to a specific
FPM.

FortiGuard web filtering
All FortiGuard rating queries are sent through management aggregate interface from the management VDOM
(named mgmt).

Log messages include a slot field
An additional "slot" field has been added to log messages to identify the FPM that generated the log.

FortiOS Carrier
You have to apply a FortiOS Carrier license separately to each FIM and FPM to license a FortiGate-7000 for
FortiOS Carrier.

Special notice for new deployment connectivity testing
Only the primary FPM can successfully ping external IP addresses. During a new deployment, while performing
connectivity testing from the Fortigate-7000, make sure to run execute ping tests from the primary FPM CLI.

Dedicated management interfaces not supported
The FortiGate-7000 does not support configuring dedicated management interfaces using the config system
dedicated-mgmt command. Instead you can enter the following to configure an interface to be dedicated to
management:

config system interface
edit <interface-name>

set dedicated-to management
end
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FortiGate-7000 Load balancing commands

See the FortiOS 5.6 CLI Reference for information about FortiGate-7000 CLI commands:

l config load-balance flow-rule
l config load-balance setting
l execute load-balance
l execute system console-server
l execute reset-vd-license
l execute log filter confsync-member
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Chapter 7 - FortiOS Carrier

FortiOS Carrier

FortiOS Carrier provides all the features found on FortiGate units plus added features specific to carrier networks.
These features are explained in this document and include dynamic profiles and groups, Multimedia messaging
service (MMS) protection, and GPRS Tunneling Protocol (GTP) protection.

This chapter contains the following sections:

l Before you begin
l How this guide is organized

Before you begin
Before you begin ensure that:

l You have administrative access to the web-based manager and/or CLI.
l The Carrier-enabled FortiGate unit is integrated into your network.
l The operation mode has been configured.

How this guide is organized
This FortiOS Handbook chapter contains the following sections:

l What's New in FortiOS 5.6
l Features and improvements that have been added in version FortiOS 5.6

l Overview of FortiOS Carrier features
l The high altitude overview of FortiOS Carrier

l "MMSConcepts" on page 769
l Basic background on MMS and its concepts so that there is some context to the settings used in the MMS

configuration
l "MMSConfiguration" on page 784

l Listing of the MMS configuration options and settings
l Procedures and insights in the configuration of the MMS components of FortiOS Carrier

l GTP basic concepts
l Basic background on GTP and its concepts so that there is some context to the settings used in the GTP

configuration
l "GTPConfiguration" on page 849

l Listing of the GTP configuration options and settings
l Procedures and insights in the configuration of the GTP components of FortiOS Carrier

l "SCTPConcepts" on page 891
l Background on SCTP, and how it makes the FortiOS Carrier different than the FortiGate
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l "Troubleshooting" on page 895
l Some basic procedures for troubleshooting FortiOS Carrier

What's New in FortiOS 5.6

New features added in 5.6.3

Improved CLI attribute name under 'gtp.message-filter-v0v1' (452813)

CLI "gtp.message-filter-v0v1" had an attribute "create-aa-pdp|init-pdp-ctx", which contains a
vertical pipe |. The attribute name was changed to "v0-create-aa-pdp--v1-init-pdp-ctx".

Its help text is also changed to avoid the vertical bar.

Syntax

config gtp message-filter-v0v1
edit <name>

set ?
......
v0-create-aa-pdp--v1-init-pdp-ctx

Improved GTP performance (423332)

There are independent Receive and Transmit queues for gtp-u process. These queues are and their associated
resources are initialized when the ftp-enhance-mode is enabled.

CLI changes under system npu

gtp-enhance-mode

config system npu
set gtp-enhance-mode [enable|disable]
end

This configuration requires a reboot of the device to initialize the changes.

gtp-enhance-cpu-range

This is used to set the CPUs which can process the GTP-U packet inspection.

config system npu
set gtp-enhance-cpu-range [0|1|2]
end
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Option Description

0 Inspect GTPU packets by all CPUs

1 Inspect GTPU packets by Master CPUs

2 Inspect GTPU packets by Slave CPUs

New diagnose commands

diagnose npu np6 hbq-stats [all|np xx]
Used to see the GTP-U packet counter by all NP or the corresponding np.

diagnose npu np6 hbq-stats-clear all /np xx

Used to clear the GTP-U packet counter by all NP or the corresponding np.

Verifying the enhance-mode is disabled

Before execute the test or enable/disable the gtp enhance, first check the gtp-enhance-mode status as in the
example below:

config system npu
get
gtp-enhance-mode: disable
gtp-enhance-cpu-range: 0
end

If the gtp-enhance-mode is disable, use the command diagnose npu np6 hbq-stats all.

The output will be similar to below:

# diagnose npu np6 hbq-stats all
Total :0

If the gtp-enhance-mode is enable, use the command diagnose npu np6 hbq-stats all

The output will be similar to below:

# diagnose npu np6 hbq-stats all
cpu_ 0:0
cpu_ 1:0
cpu_ 2:0
cpu_ 3:0
cpu_ 4:0
cpu_ 5:0
cpu_ 6:0
cpu_ 7:0
cpu_ 8:0
cpu_ 9:0
cpu_10:0
cpu_11:0
cpu_12:0
cpu_13:0
cpu_14:0
cpu_15:0
cpu_16:0
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cpu_17:0
cpu_18:0
cpu_19:0
cpu_20:0
cpu_21:0
cpu_22:0
cpu_23:0
cpu_24:0
cpu_25:0
cpu_26:0
cpu_27:0
cpu_28:0
cpu_29:0
cpu_30:0
cpu_31:0
cpu_32:0
cpu_33:0
cpu_34:0
cpu_35:0
cpu_36:0
cpu_37:0
cpu_38:0
cpu_39:0
Total :0

Sometimes, when loading the new configure file, and the new configure file does not match the old configure file,

the gtp-enhance-mode status will be confused.

You can see :

#config system npu
#get
gtp-enhance-mode: enable

but you can also see that

diagnose npu np6 hbq-stats all
Total :0

This means the gtp-enhance-mode is actually set to disable.

The inverse is also possible, when you see

#config system npu
#get
gtp-enhance-mode: disable

but you also see that

# diagnose npu np6 hbq-stats all
cpu_ 0:0
...
cpu_39:0
Total :0

This means the gtp-enhance-mode is actually set to enable.
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If these combinations occur, just run the command below:

config system npu
set gtp-enhance-mode enable
end

or

config system npu
set gtp-enhance-mode disable
end

Once this is done,reboot the device to let the 2 statuses match.

New features added in 5.6.1

GTP enhancement and GTP Performance Improvement. (423332)

The GTP changes in 5.6.1 take place in the following categories:

New GTP features and functionality enhancements.

l GTPmessage filter enhancements, including:
l Unknown message white list
l GTPv1 and GTPv2 profile separation
l Message adoption.

l GTP IE white list.
l Global APN rate limit, including:

l sending back REJECT message with back-off timer
l "APN congestion" cause value

l GTP half-open, half-close configurable timer.

GTP performance improvements.

l Implemented RCU on GTP-U running path. i.e, no locking needed to look up tunnel state when processing GTP-U.

Note the RCU is only applied on GTPv1 and GTPv2 tunnels. It is not used for GTPv0 tunnels, due to the fact
that (1) GTPv0 traffic is relatively minor compared with GTPv1 and GTPv2, and (2) GTPv0 tunnel indexing is
totally different from GTPv1 and GTPv2. GTPv0 tunnel is indexed by [IMSI, NSAPI]. GTPv1 and GTPv2 tunnel
is indexed by [IP, TEID]

l Localized CPUmemory usage on GTP-U running path.

l GTP-C: changed some GTP tables from RB tree to hash table, including
l GTP request tables, and GTPv0 tunnel tables.
l Testing showed, when handling millions of entries adding/deleting, hash table performance was much better.
l 2.3.2 Hash table is compatible with RCU API, so we can apply RCU on these GTP-C tables later for further

performance improvements.

l GTP-C, improved GTP path management logic, so that GTP path will time out sooner when there are no tunnels
linked to it

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

765



What's New in FortiOS 5.6 Chapter 7 - FortiOS Carrier

CLI Changes:

New Diagnose commands:

diagnose firewall gtp

Option Description

hash-stat-tunnel GTP tunnel hash statistics.

hash-stat-v0tunnel GTPv0 tunnel hash statistics.

hash-stat-path GTP path hash statistics.

hash-stat-req GTP request hash statistics.

vd-apn-shaper APN shaper on VDOM level.

ie-white-list-v0v1 IE white list for GTPv0 or v1.

ie-white-list-v2 IE white list for GTPv2.

diagnose firewall gtp vd-apn-shaper

Option Description

list List

diagnose firewall gtp ie-white-list-v0v1

Option Description

list List

diagnose firewall gtp ie-white-list-v2

Option Description

list List

config gtp apn-shaperapn-shaper
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Option Description

apn APN to match. Leave empty to match ANY.

"apn" field can be empty, it matches
ANY apn. when configured, it is used to
set a limit for any apn which is not
explicitly listed; Also, if configured, such
an entry should be the last entry, as it is
first-match rule.

rate-limit Rate limit in packets/s (0 - 1000000, 0 means
unlimited).

action Action. [drop | reject]

There is no back-off timer in GTPv0,
therefor the reject action is not
available for V0

back-off-time Back off time in seconds (10 - 360).

back-off-time visible when action is
"reject"

Changed commands:

Under command firewall gtp, config message-filter is replaced by set message-filter-
v0v1

Example:
config firewall gtp

edit <name>
set message-filter-v0v1

New fields have been added to the config firewall gtp command context

Option Description

half-open-timeout Half-open tunnel timeout (in seconds).

half-close-timeout Half-close tunnel timeout (in seconds).

Example:
config firewall gtp

edit <name>
set half-open-timeout 10
set half-close-timeout 10
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Models affected by change

l FortiGate 3700D
l FortiGate 3700DX
l FortiGate 3800D
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Overview of FortiOS Carrier features

FortiOS Carrier specific features include Multimedia messaging service (MMS) protection, and GPRS Tunneling
Protocol (GTP) protection.

All FortiGate units, carrier-enabled or not, are capable of handling Stream Control Transmission Protocol (SCTP)
traffic, which is a protocol designed for and primarily used in Carrier networks.

This section includes:

Overview
FortiOS Carrier provides all the features found on FortiGate units plus added features specific to carrier networks:
MMS and GTP.

MMS
MMS is a standard for sending messages that include multimedia content between mobile phones. MMS is also
popular as a method of delivering news and entertainment content including videos, pictures, and text. Carrier
networks include four different MMS types of messages— MM1, MM3, MM4, and MM7.

GTP
The GPRS Tunneling Protocol (GTP) runs on GPRS carrier networks. GPRS is a GSM packet radio standard. It
provides more efficient usage of the radio interface so that mobile devices can share the same radio channel.
FortiOS supports GTPv1 and GTPv2.

GPRS provides direct connections to the Internet (TCP/IP) and X.25 networks for point-to-point services
(connection-less/connection oriented) and point-to-multipoint services (broadcast).

GPRS currently supports data rates from 9.6 kbps to more than 100 kbps, and it is best suited for burst forms of
traffic. GPRS involves both radio and wired components. The mobile phone sends the message to a base station
unit (radio based) that converts the message from radio to wired, and sends the message to the carrier network
and eventually the Internet (wired carrier network). See GTP.

MMS Concepts

MMS background
MMS is a common method for mobile users to send and receive multimedia content. A Carrier network supports
MMS across its network. This makes up the MMSService Provider Network (MSPN).

Messages can be sent or received between the MMSC and a number of other services including the Internet,
content providers, or other carriers. Each of these different service connections uses different MMS formats
including MM1 and MM7 messages (essentially HTTP format), and MM3 and MM4 messages (SMTP formatted).
These different formats reflect the different purposes and content for each type of MMSmessage.
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MMS content interfaces

MMS content interfaces

MMSmessages are sent from devices and servers to other devices and servers using MMS content interfaces

There are eight interfaces defined for the MMS standard, referred to as MM1 through MM8. The most important
of these interfaces for the transfer of data is the MM1 interface, as this defines how mobile users communicate
from the mobile network to the Multimedia Message Service Center (MMSC). MMS content to be monitored and
controlled comes from these mobile users and is going to the provider network.

Other MMS content interfaces that connect a service provider network to other external sources can pose threats
as well. MM3 handles communication between the Internet and the MMSC and is a possible source of viruses
and other content problems from the Internet. MM4 handles communication between different content provider
MMSCs. Filtering MM4 content protects the service provider network from content sent from foreign service
providers and their subscribers. Finally MM7 is used for communication between content providers and the
MMSC. Filtering MM3 content can also keep harmful content off of the service provider network.
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MMS content interfaces

Type Transaction Similar to

MM 1 Handset to MMSC HTTP

MM 3 Between MMSC and Internet SMTP

MM 4 Between Operator MMSCs SMTP

MM 7 Content Providers to MMSC HTTP and SOAP

How MMS content interfaces are applied

As shown below, the sender’s mobile device encodes the MMS content in a form similar to MIME email message
(MMSMIME content formats are defined by the MMSMessage Encapsulation specification). The encoded
message is then forwarded to the service provider’s MMSC. Communication between the sending device and the
MMSC uses the MM1 content interface. The MM1 content interface establishes a connection and sends an MM1
send request (m-send.req) message that contains the MMSmessage. The MMSC processes this request and
sends back an MM1 send confirmation (m-send.conf) HTTP response indicating the status of the message—
accepted or an error occurred, for example.

MM1 transactions between senders and receivers and the MMSC

MMSC

2. m-notification.req (indicates mesage is
available for delivery, includes size, expiry

and URI)

Sender 
(sends MMS message

to receiver)

Receiver
(receives MMS message

from sender)

6. m-retrieve.conf (the MMS content)

4. m-notifyresp.ind (WSP/HTTP POST to
confirm receipt of notification)

5. WSP/HTTP GET.req
(Requests the MM.content)

7. m-acknowledge.ind (if requested, optional
acknowledgment of receipt of MMS content)

1. m-send.req (contains the MMS message and
is directed to the URI of the MMSC)

3. m-send.conf (confirms message receipt and
handles any error conditions, also includes

transaction identity)

8. m-delivery.ind (optional, confirms delivery 
of MMS content)

If the recipient is on another carrier, the MMSC forwards the message to the recipient's carrier. This forwarding
uses the MM4 content interface for forwarding content between operator MMSCs (see the figure below).
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Before the MMSC can forward the message to the final recipient, it must first determine if the receiver’s handset
can receive MMSmessages using the MM1 content interface. If the recipient can use the MM1 content interface,
the content is extracted and sent to a temporary storage server with an HTTP front-end.

To retrieve the message, the receiver’s handset establishes a connection with the MMSC. An HTTP get request
is then sent from the recipient to the MMSC. This message contains the URL where the content of the message
is stored. The MMSC responds with a retrieve confirmation (m-retrieve.conf) HTTP response that contains
the message.

MM4 messages sent between operator MMSCs

Sending Operator
MMSC

Receiving Operator
MMSC

1. MM4-forward.req (contains the MMS content and
is directed to the receiving MMSC.

X-MMS headers contain MMS extensions)

4. MM4-delivery_report.res (response to feedback
request with status codes)

2. MM4-forward.res (administrative message
to confirm transaction with status code)

3. MM4-delivery-report.req (feedback
required by UA pr VASP)

This causes the receiver’s handset to retrieve the content from the embedded URL. Several messages are
exchanged to indicate status of the delivery attempt. Before delivering content, some MMSCs also include a
content adaptation service that attempts to modify the multimedia content into a format suitable for the
recipient’s handset.
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If the receiver’s handset is not MM1 capable, the message can be delivered to a web based service and the
receiver can view the content from a normal Internet browser. The URL for the content can be sent to the receiver
in an SMS text message. Using this method, non-MM1 capable recipients can still receive MMS content.

The method for determining whether a handset is MMS capable is not specified by the standards. A database is
usually maintained by the operator, and in it each mobile phone number is marked as being associated with a
legacy handset or not. It can be a bit hit and miss since customers can change their handset at will and this
database is not usually updated dynamically.

Email and web-based gateways from MMSC to the Internet use the MM3 content interface. On the receiving
side, the content servers can typically receive service requests both from WAP and normal HTTP browsers, so
delivery via the web is simple. For sending from external sources to handsets, most carriers allow MIME encoded
message to be sent to the receiver's phone number with a special domain.

How FortiOS Carrier processes MMS messages
MMSmessages can be vectors for propagating undesirable content such as spam and viruses. FortiOS Carrier
can scan MMSmessages sent using the MM1, MM3, MM4, and MM7 content interfaces. You can configure
FortiOS Carrier to scan MMSmessages for spam and viruses by configuring and adding MMS protection profiles
and adding the MMS protection profiles to security policies. You can also use MMS protection profiles to apply
content blocking, carrier endpoint filtering, MMS address translation, sending MMS notifications, DLP archiving
of MMSmessages, and logging of MMSmessage activity.
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FortiOS Carrier MMS processing

FortiOS Carrier can send MMSmessages to senders informing those senders that their devices are infected.
FortiOS Carrier can also send MMS notifications to administrators to inform them of suspicious activity on their
networks.

For message floods and duplicate messages, FortiOS Carrier does not send notifications to message senders but
does send notifications to administrators and sends messages to sender handsets to complete MM1 and MM4
sessions.

Where MMSmessaging uses the TCP/IP set of protocols, SMS text messaging uses the Signaling System
Number 7 (SS7) set of protocols, which is not supported by FortiOS.
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FortiOS Carrier and MMS content scanning

The following section applies to MMS content scanning, including virus scanning, file filtering, content spam
filtering, carrier endpoint filtering, and MMS content checksum filtering.

MM1 Content Scanning

During MM1 content scanning a message is first transmitted from the sender, establishing a connection with the
MMSC. FortiOS Carrier intercepts this connection and acts as the endpoint. FortiOS Carrier then establishes its
own connection to the MMSC. Once connected, the client transmits its m-send.req HTTP post request to
FortiOS Carrier which scans it according to the MMS protection profile settings. If the content is clean, the
message is forwarded to the MMSC. The MMSC returns m-send.conf HTTP response through FortiOS Carrier
to the sender.

If FortiOS Carrier blocks the message (for example because a virus was found, see the figure below), FortiOS
Carrier resets the connection to the MMSC and sends m-send.conf HTTP response back to the sender. The
response message can be customized using replacement messages. FortiOS Carrier then terminates the
connection. Sending back an m-send.conf message prevents the sender from trying to send the message
again.
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MM1 MMS scanning of message sent by sender (blocking m.send.req messages)

MMSC

1. Open TCP session

2. Open TCP session

Sender FortiOS Carrier

3. m-send.req

6. m-send.conf replacement
message 

4. Content blocked

5. Reset TCP session

8. m-send.rec notification message
to sender

Sent once per notification period,
regardless of how many messages

are blocked

(MM1 or MM7/SOAP payload, by configuration)

7. Close TCP Session

9. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked

FortiOS Carrier also sends m-send.rec notifications messages to the MMSC that are then forwarded to the
sender to notify them of blocked messages.

Filtering message retrieval

FortiOS Carrier intercepts the connection to the MMSC, and the m-retrieve.conf HTTP response from the MMSC
is scanned according to the MMS content scanning settings. If the content is clean, the response is forwarded
back to the client. If the content is blocked, FortiOS Carrier drops the connection to the MMSC. It then builds an
m-retrieve.conf message from the associated replacement message and transmits this back to the client.

FortiOS Carrier also sends m-send.rec notifications messages to the MMSC that are then forwarded to the
receiver to notify them of blocked messages.
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MM1 MMS scanning of messages received by receiver (blocking m.retrieve.conf messages)

MMSC

1. GET request for message

ReceiverFortiOS Carrier

2. GET request for message

3. m-retrieve.conf mesage

5. m-retrieve.conf replacement
message

4. Content blocked

6. m-send.rec notification message
to sender

Sent once per notification period,
regardless of how many messages

are blocked

(MM1 or MM7/SOAP payload, by configuration)

7. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked

Filtering MM3 and MM4 messages works in an similar way to MM1 (see the figures below). FortiOS Carrier
intercepts connections to the MMSC, and scans messages as configured. When messages are blocked, FortiOS
Carrier closes sessions as required, sends confirmation messages to the sender, notifies administrators, and
notifies senders and receivers of messages.
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MM3 MMS scanning of messages sent from a sender on the Internet to an MMSC

Sender on the Internet

1. Open TCP session

MMSCFortiOS Carrier

3. Send full email message

4. Send full email message

Without ‘.’ on single line

2. Open TCP session

6. Reset TCP session

3. m-retrieve.conf mesage

5. Content blocked

7. Send 550 Error and replacement
message

8. Close TCP session

9. MM3 notification message

Sent once per notification period,
regardless of how many messages

are blocked

Internet

10. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked
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MM4 MMS scanning of messages sent between operator MMSCs

1. Open TCP session

FortiOS Carrier

3. Send full MM4-forward.req
message

2. Open TCP session

7. Reset TCP session

5. m-retrieve.conf mesage

6. Content blocked

8. Send 250 response

9. Close TCP session

12. Close TCP session

13. MM4-forward.req notification

10. Open new TCP session

11. Send MM4-forward.res message

Sent once per notification period,
regardless of how many messages

are blocked

10, 11, 12 Only initiated if the
MM4-forward.req message

requested a response

Sending Operator
MMSC

Receiving Operator
MMSC

Without ‘.’ on single line

4. Send full MM4-forward.req
message

14. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

779



MMSConcepts Chapter 7 - FortiOS Carrier

MM7 MMS scanning of messages sent between a VASP and an MMSC

1. Open TCP session

FortiOS Carrier

3. submit.req or delivery.req

2. Open TCP session

5. Reset TCP session
4. Content blocked

6. submit.resp/delivery.resp
replacement message

7. Close TCP session

8. submit.req/delivery.req
notification message

Sent once per notification period,
regardless of how many messages

are blocked

Sending
VASP

Receiving
MMSC

9. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked

FortiOS Carrier and MMS duplicate messages and message floods

FortiOS Carrier detects duplicate messages and message floods for the MM1 and MM4 interfaces. How FortiOS
Carrier detects and responds to duplicate messages and message floods is different from how FortiOS Carrier
detects and responds to viruses and other MMS scanning protection measures.

For message floods and duplicate messages, the sender does not receive notifications about floods or duplicate
messages, as if the sender is an attacker they can gain useful information about flood and duplicate thresholds.
Plus, duplicate messages and message floods are usually a result of a large amount of messaging activity and
filtering of these messages is designed to reduce the amount of unwanted messaging traffic. Adding to the traffic
by sending notifications to senders and receivers could result in an increase in message traffic.

You can create up to three thresholds for detecting duplicate messages and message floods. For each threshold
you can configure the FortiOS Carrier unit to respond by logging the activity, archiving or quarantining the
messages, notifying administrators of the activity, and by blocking the messages. In many cases you may only
want to configure blocking for higher activity thresholds, and to just monitor and send administrator notifications
at lower activity thresholds.
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When a block threshold is reached for MM1 messages, FortiOS Carrier sends m-send.conf or m-retrieve.conf
messages to the originator of the activity. These messages are sent to end the MM1 sessions, otherwise the
originator would continue to re-send the blocked message. When a block threshold is reached for MM4, FortiOS
Carrier sends a MM4-forward.res message to close the MM4 session. An MM4 message is sent only if
initiated by the originating MM4-forward.req message.

MM1 message flood and duplicate message blocking of sent messages

MMSC

1. Open TCP session

2. Open TCP session

Sender FortiOS Carrier

3. m-send.req

6. m-send.conf replacement
message 

4. Flood or duplicate blocked

5. Reset TCP session

8. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked

7. Close TCP Session
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MM1 message flood and duplicate message blocking of received messages

MMSC

1. GET request for message

ReceiverFortiOS Carrier

2. GET request for message

3. m-retrieve.conf mesage

5. m-retrieve.conf replacement
message

6. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked

4. Flood or duplicate blocked
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MM4 message flood and duplicate message blocking

1. Open TCP session

FortiOS Carrier

3. Send full MM4-forward.req
message

2. Open TCP session

7. Reset TCP session

5. m-retrieve.conf mesage

8. Send 250 response

9. Close TCP session

12. Close TCP session

10. Open new TCP session

11. Send MM4-forward.res message
10, 11, 12 Only initiated if the

MM4-forward.req message
requested a response

Forwarding Operator
MMSC

Receiving Operator
MMSC

Without ‘.’ on single line

4. Send full MM4-forward.req
message

6. Flood or duplicate blocked

13. Notification message to
administrators (various protocols)

Sent once per notification period,
regardless of how many messages

are blocked

MMS protection profiles
An MMS protection profile is a group of settings that you can apply to an MMS session matched by a security
policy.

MMS protection profiles are easy to configure and can be used by more than one security policy. You can
configure a single MMS protection profile for the different traffic types handled by a set of security policies that
require identical protection levels and types. This eliminates the need to repeatedly configure those same MMS
protection profile settings for each individual security policy.
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For example, while traffic between trusted and untrusted networks might need strict protection, traffic between
trusted internal addresses might need only moderate protection. You would configure two separate MMS
protection profiles to provide the different levels of protection: one for traffic between trusted networks, and one
for traffic between trusted and untrusted networks.

Once you have configured the MMSProtection Profile, you need to add it to a security policy to apply the profile
to MMS traffic.

Bypassing MMS protection profile filtering based on carrier endpoints
You can use carrier endpoint filtering to exempt MMS sessions from MMS protection profile filtering. Carrier
endpoint filtering matches carrier endpoints in MMS sessions with carrier endpoint patterns. If you add a carrier
endpoint pattern to a filter list and set the action to exempt from all scanning, all messages from matching carrier
endpoints bypass MMS protection profile filtering. See Bypassing message flood protection based on user’s
carrier endpoints.

Applying MMS protection profiles to MMS traffic
To apply an MMS protection profile you must first create the MMS protection profile and then add the MMS
protection profile to a security policy by enabling the Carrier security profile. The MMS protection profile then
applies itself to the traffic accepted by that security policy.

MMS protection profiles can contain settings relevant to many different services. Each security policy uses the
subset of the MMS protection profile settings that apply to the sessions accepted by the security policy. In this
way, you might define just one MMS protection profile that can be used by many security policies, each policy
using a different or overlapping subset of the MMS protection profile.

To add an MMS protection profile to a security policy

1. Go to Security Profiles > MMS Profile.
2. Select Create New to add an MMS protection profile.
3. Configure as needed, and save.
4. Go to Policy & Objects > IPv4 Policy.
5. Select Create New to add a security policy, or select an existing policy and Edit to add the MMS profile.
6. Configure the security policy as required.
7. EnableMMS Profile, and select the MMS profile to add to the security policy.
8. Select OK.

MMS Configuration

MMS profiles
Since MMS profiles can be used by more than one security policy, you can configure one profile for the traffic
types handled by a set of security policies requiring identical protection levels and types, rather than repeatedly
configuring those same profile settings for each individual security policy.
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If the security policy requires authentication, do not select the MMS profile in the
security policy. This type of profile is specific to the authenticating user group. For
details on configuring the profile associated with the user group, see User Groups in
the Authentication guide.

For example, while traffic between trusted and untrusted networks might need strict protection, traffic between
trusted internal addresses might need moderate protection. To provide the different levels of protection, you
might configure two separate protection profiles: one for traffic between trusted networks, and one for traffic
between trusted and untrusted networks.

Once you have configured the MMS profile, you can then apply the profile to MMS traffic by applying it to a
security policy.

MMS profiles can contain settings relevant to many different services. Each security policy uses the subset of the
MMS profile settings that apply to the sessions accepted by the security policy. In this way, you might define just
one MMS profile that can be used by many security policies, each policy using a different or overlapping subset of
the MMS profile.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

785



MMSConfiguration Chapter 7 - FortiOS Carrier

The MMSProfile page contains options for each of the following:

l MMS scanning
l MMSBulk Email Filtering Detection
l MMSAddress Translation
l MMSNotifications
l DLP Archive
l Logging

MMS profile configuration settings

The following are MMS profile configuration settings in Security Profiles > MMS Profile.

MMS Profile page

Lists each individual MMS profile that you created. On this page, you can edit, delete or create an MMS
profile.

Create New Creates a new MMS profile. When you select Create New, you are
automatically redirected to the New MMSProfile page.

Edit Modifies settings within an MMS profile. When you select Edit, you are
automatically redirected to the Edit MMSProfile.

Delete

Removes an MMS profile from the list on the MMSProfile page.

To remove multiple MMS profiles from within the list, on the MMSProfile
page, in each of the rows of the profiles you want removed, select the
check box and then select Delete.

To remove all MMS profiles from the list, on the MMSProfile page, select
the check box in the check box column, and then select Delete.

Name The name of the MMS profile.
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Ref.

Displays the number of times the object is referenced to other objects. For
example, av_1 profile is applied to a security policy; on the Profile page
(Security Profiles > Antivirus), 1 appears in Ref. .

To view the location of the referenced object, select the number in Ref.,
and the Object Usage window appears displaying the various locations of
the referenced object.

To view more information about how the object is being used, use one of
the following icons that is avialable within the Object Usage window:

View the list page for these objects – automatically redirects you to the
list page where the object is referenced at.

Edit this object – modifies settings within that particular setting that the
object is referenced with. For example, av_1 profile is referenced with a
security policy and so, when this icon is selected, the user is redirected to
the Edit Policy page.

View the details for this object – table, similar to the log viewer table,
contains information about what settings are configured within that
particular setting that the object is referenced with. For example, av_1
profile is referenced with a security policy, and that security policy’s settings
appear within the table.

New MMS Profile page

Provides settings for configuring an MMS profile. This page also provides settings for configuring DLP
archives and logging.

Profile Name Enter a name for the profile.

Comments Enter a description about the profile. This is optional.

MMS Scanning Configure MMSScanning options.

MMS Bulk Email Filtering
Detection

Configure MMSBulk Email options.

MMS Address Translation Configure MMSAddress Translation options.

MMS Notifications Configure MMSNotification options.

DLP Archive Configure DLP archive option.

Logging Configure logging options.

MMS scanning options

You can configure MMS scanning protection profile options to apply virus scanning, file filtering, content filtering,
carrier endpoint blocking, and other scanning to MMSmessages transmitted using the MM1, MM3, MM4 and
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MM7 protocols.

The following are the MMSScanning options that are available within an MMS profile. You can create an MMS
profile in Security Profiles > MMS Profile or edit an existing one. You must expand MMSScanning to access
the following options.

MMS Scanning section of the New MMS Profile page

Monitor Only Select to cause the unit to record log messages when MMS scanning
options find a virus, match a file name, or match content using any of
the other MMS scanning options. Select this option to be able to report
on viruses and other problems in MMS traffic without affecting users.

Tip: Select Remove Blocked if you want the unit to actually remove
content intercepted by MMS scanning options.

Virus Scan

Select to scan attachments in MMS traffic for viruses.

Since MM1 and MM7 use HTTP, the oversize limits for HTTP and the
HTTP antivirus port configuration also applies to MM1 and MM7
scanning.

MM3 and MM4 use SMTP and the oversize limits for SMTP and the
SMTP antivirus port configuration also applies to MM3 and MM4
scanning.

Scan MM1 message retrieval Select to scan message retrievals that use MM1. If you enable Virus
Scan for all MMS interfaces, messages are also scanned while being
sent. In this case, you can disable MM1 message retrieval scanning to
improve performance.

Remove Blocked

Select to remove blocked content from each protocol and replace it with
the replacement message.

Select Constant if the unit is to preserve the length of the message
when removing blocked content, as may occur when billing is affected
by the length of the message.

Tip: If you only want to monitor blocked content, select Monitor Only.

Content Filter Select to filter messages based on matching the content of the
message with the words or patterns in the selected web content filter
list.

Carrier Endpoint Block Select to add Carrier Endpoint Filtering in this MMS profile. Select
the carrier endpoint filter list to apply it to the profile.

MMS Content Checksum Select to add MMSContent Checksum in this MMS profile. Select the
MMS content checksum list to apply it to the profile.
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MMS Scanning section of the New MMS Profile page

Pass Fragmented Messages
Select to pass fragmented MM3 and MM4 messages. Fragmented
MMSmessages cannot be scanned for viruses. If you do not select
these options, fragmented MM3 and MM4 message are blocked.

Comfort Clients Select client comforting for MM1 and MM7 sessions.

Since MM1 and MM7 messages use HTTP, MM1 and MM7 client
comforting operates like HTTP client comforting.

Comfort Servers

Select server comforting for each protocol.

Similar to client comforting, you can use server comforting to prevent
server connection timeouts that can occur while waiting for the unit to
buffer and scan large POST requests from slow clients.

Interval (1-900
seconds)

Enter the time in seconds before client and server comforting starts
after the download has begun, and the time between sending
subsequent data.

Amount (1-10240
bytes) The number of bytes sent by client or server comforting at each interval.

Oversized MMS Message Select Block or Pass for files and email messages exceeding
configured thresholds for each protocol.

The oversize threshold refers to the final size of the message, including
attachments, after encoding by the client. Clients can use a variety of
encoding types; some result in larger file sizes than the original
attachment. As a result, a file may be blocked or logged as oversized
even if the attachment is several megabytes smaller than the oversize
threshold.

Threshold (1KB - 800
MB)

Enter the oversized file threshold and select KB or MB. If a file is larger
than the threshold the file is passed or blocked depending on the
Oversized MMS Message setting. The web-based manager displays
the allowed threshold range. The threshold maximum is 10% of the
unit’s RAM.

MMS Bulk Anti-Spam Detection options

You can use the MMS bulk email filtering options to detect and filter MM1 and MM4 message floods and
duplicate messages. You can configure three thresholds that define a flood of message activity and three
thresholds that define excessive duplicate messages. The configuration of each threshold includes the response
actions for the threshold.

The configurable thresholds for each of the flood and duplicate sensors and must be enabled in sequence. For
example, you can enable Flood Threshold 1 and Flood Threshold 2, but you cannot disable Flood Threshold 1
and enable Flood Threshold 2.
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You can also add MSISDN to the bulk email filtering configuration and select a subset of the bulk email filtering
options to applied to these individual MSISDNs.

You must first select MM1 and/or MM4 to detect excessive message duplicates. If excessive message duplicates
are detected, the unit will perform the Duplicate Message Action for the specified duration.

You can configure three duplicate message thresholds and enable them with separate values and actions. They
are labeled Duplicate Threshold 1 through 3 and must be enabled in sequence. For example, you can enable
Duplicate Threshold 1 and Duplicate Threshold 2, but you cannot disable Duplicate Threshold 1 and enable
Duplicate Threshold 2.

When traffic accepted by a security policy that contains an MMS profile with duplicate message configured
receives MM1 or MM4 duplicate messages that match a threshold configured in the MMS protection profile, the
unit performs the duplicate message action configured for the matching threshold.

You can configure three message flood thresholds and enable them with separate values and actions. They are
labeled Flood Threshold 1 through 3 and must be enabled in sequence. For example, you can enable Flood
Threshold 1 and Flood Threshold 2, but you cannot disable Flood Threshold 1 and enable Flood Threshold 2.

When traffic accepted by a security policy that contains an MMS protection profile with message flooding
configured experiences MM1 or MM4 message flooding that matches a threshold configured in the MMS profile,
the unit performs the message flood action configured for the matching threshold.

MMS Bulk Anti-Spam Detection

This section of the New MMSProfile page contains numerous sections where you can configure specific
settings for flood threshold, duplicate threshold and recipient MSISDNs.

Message Flood

The message flood settings for each flood threshold. Expand each to configure settings for a threshold.

Flood Threshold 1 Expand to reveal the flood threshold settings for Flood Threshold 1. The
settings for Flood Threshold 1 are the same for Flood Threshold 2 and 3.

Enable Select to apply Flood Threshold 1 to the MSISDN exception.

Message Flood
Window

Enter the period of time during which a message flood will be detected if
theMessage Flood Limit is exceeded. The message flood window can
be 1 to 2880 minutes (48 hours).

Message Flood Limit Enter the number of messages which signifies a message flood if
exceeded within theMessage Flood Window.

Message Flood Block
Time

Enter the amount of time during which the unit performs theMessage
Flood Action after a message flood is detected.

Message Flood
Action

Select one or more actions that the unit is to perform when a message
flood is detected.
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Flood Threshold 2

Flood Threshold 3

Expand to configure settings for Flood Threshold 2 or 3 respectively.

Duplicate Message

The duplicate message threshold settings. Expand each to configure settings for a threshold.

MM1 Retrieve Duplicate
Enable

Select to scan MM1 mm1-retr messages for duplicates. By default,
mm1-retr messages are not scanned for duplicates as they may often
be the same without necessarily being bulk or spam.

Enable Select to enable the selected duplicate message threshold and to make
the rest of the options available for configuration.

Duplicate Message
Window

Enter the period of time during which excessive message duplicates will
be detected if the Duplicate message Limit it exceeded. The duplicate
message window can be 1 to 2880 minutes (48 hours).

Duplicate Message
Limit

Enter the number of messages which signifies excessive message
duplicates if exceeded within the Duplicate Message Window.

Duplicate Message
Block Time

Enter the amount of time during which the unit will perform the Duplicate
Message Action after a message flood is detected.

Duplicate Message
Action

Select one or more actions that the unit is to perform when excessive
message duplication is detected.

Duplicate Threshold 2

Duplicate Threshold 3

Expand to configure settings for Duplicate Threshold 2 or 3 respectively.

Recipient MSISDN

The recipient Mobile Subscriber Integrated Services Digital Network Number (MSISDN) settings for each
recipient MSISDN. When you select Create New, you are automatically redirected to the New MSISDN
page.

You need to save the profile before you can add MSISDNs.

Recipient MSISDN The recipient MSISDN.

Flood Threshold 1 Check to enable Flood Threshold 1 settings for this MSISDN.

Flood Threshold 2 Check to enable Flood Threshold 2 settings for this MSISDN.

Flood Threshold 3 Check to enable Flood Threshold 3 settings for this MSISDN..

Duplicate Threshold 1 Check to enable Duplicate Threshold 1 settings for this MSISDN.
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Duplicate Threshold 2 Check to enable Duplicate Threshold 2 settings for this MSISDN..

Duplicate Threshold 3 Check to enable Duplicate Threshold 3 settings for this MSISDN..

Edit
Modifies the settings of a Recipient MSISDN in the Recipient MSISDN
list. When you select Edit, you are automatically redirected to the New
MSISDN page.

Delete Removes a Recipient MSISDN in the Recipient MSISDN list within the
Recipient MSISDN section of the page.

New MSISDN page

Create New Creates a new Recipient MSISDN. When you select Create New, you
are automatically redirected to the New MSISDN page.

Recipient MSISDN Enter a name for the recipient MSISDN.

Flood Threshold 1 Select to apply Flood Threshold 1 to the MSISDN exception.

Flood Threshold 2 Select to apply Flood Threshold 2 to the MSISDN exception.

Flood Threshold 3 Select to apply Flood Threshold 3 to the MSISDN exception.

Duplicate Threshold 1 Select to apply Duplicate Threshold 1 to the MSISDN exception.

Duplicate Threshold 2 Select to apply Duplicate Threshold 2 to the MSISDN exception.

Duplicate Threshold 3 Select to apply Duplicate Threshold 3 to the MSISDN exception.

MMS Address Translation options

The sender’s carrier endpoint is used to provide logging and reporting details to the mobile operator and to
identify the sender of infected content.

When MMSmessages are transmitted, the From field may or may not contain the sender's address. When the
address is not included, the sender information will not be present in the logs and the unit will not be able to notify
the user if the message is blocked unless the sender's address is made available elsewhere in the request.

The unit can extract the sender's address from an extended HTTP header field in the HTTP request. This field
must be added to the HTTP request before it is received by the unit. If this field is present, it will be used instead
of the sender's address in the MMSmessage for logging and notification. If this header field is present when a
message is retrieved, it will be used instead of the To address in the message. If this header field is not present
the content of the To header field is used instead.

Alternatively, the unit can extract the sender’s address from a cookie.

You can configure MMS address translation to extract the sender’s carrier endpoint so that it can be added to log
and notification messages. You can configure MMS address translation settings to extract carrier endpoints from
HTTP header fields or from cookies. You can also configure MMS address translation to add an endpoint prefix to
the extracted carrier endpoints. For more information, see Dynamic Profiles and Endpoints in the Authentication
guide.
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MMS Address Translation

Sender Address Source Select to extract the sender’s address from the HTTP Header Field or
a Cookie. You must also specify the identifier that contains the carrier
endpoint.

Sender Address Identifier

Enter the sender address identifier that includes the carrier endpoint.
The default identifier is x-up-calling-line-id.

If the Sender Address Source isHTTP Header Field, the address
and its identifier in the HTTP request header takes the format:

<Sender Address Identifier>: <MSISDN_value>

Where the <MSISDN_value> is the carrier endpoint. For example, the
HTTP header might contain:

x-up-calling-line-id: 6044301297

where x-up-calling-line-id would be the Sender Address
Identifier.

If the Sender Address Source is Cookie, the address and its identifier
in the HTTP request header’s Cookie field takes the format of
attribute-value pairs:

Cookie: id=<cookie-id>;

<Sender Address Identifier>=<MSISDN Value>

For example, the HTTP request headers might contain:

Cookie: id=0123jf!a;x-up-calling-line-
id=6044301297

where x-up-calling-line-id would be the Sender Address
Identifier.

Convert Sender Address From
/ To HEX

Select to convert the sender address from ASCII to hexadecimal or from
hexadecimal to ASCII. This is required by some applications.

Add Carrier Endpoint Prefix
for Logging / Notification

Select the following to enable adding endpoint prefixes for logging and
notification.

Enable Select to enable adding the country code to the extracted carrier
endpoint, such as the MSISDN, for logging and notification purposes.
You can limit the number length for the test numbers used for internal
monitoring without a country code.
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MMS Address Translation

Prefix
Enter a carrier endpoint prefix to be added to all carrier endpoints. Use
the prefix to add extra information to the carrier endpoint in the log
entry.

Minimum Length Enter the minimum length of the country code information being added.
If this and Maximum Length are set to zero (0), length is not limited.

Maximum Length Enter the maximum length of the country code information being added.
If this and Minimum Length are set to zero (0), length is not limited.

MMS Notifications

MMS notifications are messages that a unit sends when an MMS profile matches content in an MM1, MM3, MM4
or MM7 session. For example, the MMS profile detects a virus or uses content blocking to block a web page, text
message or email. You can send notifications to the sender of the message using same protocol and the
addressing headers in the original message. You can also configure MMS notifications to send notification
messages to another destination (such as a system administrator) using the MM1, MM3, MM4 or MM7 protocol.

You need to enable one or more Notification Types or you can add an Antivirus Notification List to enable
sending notifications,.

You can also use MMS notifications options to configure how often notifications are sent. The unit sends
notification messages immediately for the first event, then at a configurable interval if events continue to occur. If
the interval does not coincide with the window of time during which notices may be sent, the unit waits to send
the notice in the next available window. Subsequent notices contain a count of the number of events that have
occurred since the previous notification.

There are separate notifications for each notification type, including virus events. Virus event notifications include
the virus name. Up to three viruses are tracked for each user at a time. If a fourth virus is found, one of the
existing tracked viruses is removed from the list.

The notifications are MM1 m-send-req messages sent from the unit directly to the MMSC for delivery to the
client. The host name of the MMSC, the URL to which m-send-req messages are sent, and the port must be
specified.

MMS Notification

Antivirus Notification List Optionally select an antivirus notification list to select a list of virus
names to send notifications for. The unit sends a notification message
whenever a virus name or prefix in the antivirus notification list matches
the name of a virus detected in a session scanned by the MMS
protection profile. Select Disabled if you do not want to use a
notification list.

Instead of selecting a notification list you can configure the Virus
ScanNotification Type to send notifications for all viruses.
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MMS Notification

Message Protocol

In each column, select the protocol used to send notification
messages. You can use a different protocol to send the notification
message than the protocol on which the violation was sent. The MMS
Notifications options change depending on the message protocol that
you select.

If you select a different message protocol, you must also enter the User
Domain. If selecting MM7 you must also enter the Message Type.

Message Type Select the MM7 message type to use if sending notifications using
MM7. Options include deliver.REQ and submit.REQ

Detect Server Details

Select to use the information in the headers of the original message to
set the address of the notification message. If you do not select this
option, you can enter the required addressing information manually.

You cannot select Detect Server Details if you are sending
notification messages using a different message protocol.

If you select Detect Server Details, you cannot change the Port
where the notification is being sent.

Hostname Enter the FQDN or the IP address of the server where the notifications
will be sent.

URL

Enter the URL of the server. For example if the notificaiton is going to
www.example.com/home/alerts , the URL is /home/alerts.

This option is available only whenMessage Protocol ismm1 or
mm7.

Port Enter the port number of the server.

You cannot change the Port if Detect Server Details is enabled.

Username

Enter the user name required for sending messages using this server
(optional).

This option is available only whenMessage Protocol ismm7.

Password Enter the password required for sending messages using this server
(optional).

This option is available only whenMessage Protocol ismm7.
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MMS Notification

VASP ID

Enter the value-added-service-provider (VASP) ID to be used when
sending a notification message. If a VAS is not offered by the mobile
provider, it is offered by a third party or a VAS provider or content
provider (CP).

This option is available only whenMessage Protocol ismm7.

VAS ID Enter the value-added-service (VAS) ID to be used when sending a
notification message. A VAS is generally any service beyond voice calls
and fax.

This option is available only whenMessage Protocol ismm7.

All Notification Types

In each column, select notification for all MMS event types for that
MMS protocol, then enter the amount of time and select the time unit
for notice intervals.

Alternatively, expand All Notification Types, and then select
notification for individual MMS event types for each MMS protocol.
Then enter the amount of time and select the time unit for notice
intervals.

Not all event types are available for all MMS protocols.

Content Filter In each column, select to notify when messages are blocked by the
content filter, then enter the amount of time and select the time unit for
notice intervals.

File Block
In each column, select to notify when messages are blocked by file
block, then enter the amount of time and select the time unit for notice
intervals.

Carrier Endpoint
Block

In each column, select to notify when messages are blocked, then
enter the amount of time and select the time unit for notice intervals.

Flood In each column, select to notify when message flood events occur, then
enter the amount of time and select the time unit for notice intervals.

Duplicate In each column, select to notify when duplicate message events occur,
then enter the amount of time and select the time unit for notice
intervals.

MMS Content
Checksum

In each column, select to notify when the content within an MMS
message is scanned and banned because of the checksum value that
was matched.

Virus Scan In each column, select to notify when the content within an MMS
message is scanned for viruses.
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MMS Notification

Notifications Per Second Limit For each MMS protocol, enter the number of notifications to send per
second. If you enter zero(0), the notification rate is not limited.

Day of Week For each MMS protocol, select the days of the week the unit is allowed
to send notifications.

Window Start Time

For each MMS protocol, select the time of day to begin the message
alert window. By default, the message window starts at 00:00. You can
change this if you want to start the message window later in the day.
When configured, notification outside this window will not be sent.

Window Duration For each MMS protocol, select the time of day at which to end the
message alert window. By default, the message window ends at 00:24.
You can change this if you want to end the message window earlier in
the day.

When configured, notification outside this window will not be sent

DLP Archive options

Select DLP archive options to archive MM1, MM3, MM4, and MM7 sessions. In addition to the MMS profile’s
DLP archive options, you can:

l Archive MM1 and MM7 message floods
l Archive MM1 and MM7 duplicate messages
l Select DLP archiving for carrier endpoint patterns in a Carrier Endpoint List and select the Carrier Endpoint
Block option in theMMS Scanning section of an MMSProfile

The unit only allows one sixteenth of its memory for transferring content archive files. For example, for units with
128 MBRAM, only 8 MB of memory is used when transferring content archive files. Best practices dictate to not
enable full content archiving if antivirus scanning is also configured because of these memory constraints.

DLP Archive

Display DLP meta-
information on the system
dashboard

Select each required protocol to display the content archive summary in the
Log and Archive Statistics dashboard widget on the System Dashboard.
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DLP Archive

Archive to
FortiAnalyzer/FortiGuard

Select the type of archiving that you want for the protocol (MM1, MM3,
MM4, and MM7). You can choose from Full, Summary or None.

None — Do not send content archives.

Summary — Send content archive metadata only. Includes information
such as date and time, source and destination, request and response size,
and scan result.

Full — Send content archive both metadata and copies of files or
messages.

In some cases, FortiOS Carrier may not archive content, or may make only
a partial content archive, regardless of your selected option. This behavior
varies by prerequisites for each protocol.

This option is available only if a FortiAnalyzer unit or FortiGuard Analysis
and Management Service is configured.

Logging

You can enable logging in an MMS profile to write event log messages when the MMS profile options that you
have enabled perform an action. For example, if you enable MMS antivirus protection, you could also use the
MMS profile logging options to write an event log message every time a virus is detected.

You must first configure how the unit stores log messages so that you can then record these logs messages. For
more information, see the FortiOS Handbook Logging and Reporting guide.

Logging

MMS-Antivirus If antivirus settings are enabled for this MMS profile, select the following
options to record Antivirus Logmessages.

Viruses Record a log message when this MMS profile detects a virus.

Blocked Files Record a log message when antivirus file filtering enabled in this MMS
profile blocks a file.

Oversized
Files/Emails

Record a log message when this MMS profile encounters an oversized
file or email message. Oversized files and email messages cannot be
scanned for viruses.

MMS Scanning If MMS scanning settings are enabled for this MMS profile, select the
following options to record Email Filter Logmessages.

Notification Messages Select to log the number of MMS notification messages sent.
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Logging

Bulk Messages Select to log MMSBulk AntiSpam events. You must also select which
protocols to write log messages for in the MMS bulk email filtering part of
the MMS profile.

Carrier Endpoint Filter
Block

Select to log MMS carrier endpoint filter events, such as MSISDN
filtering.

MMS Content
Checksum

Select to log MMS content checksum activity.

Content Block Select to log content blocking events.

MMS Content Checksum
The MMSContent Checksum menu allows you to configure content checksum lists.

Configure MMS content checksum lists in Security Profiles > MMS Content Checksum using the following
table.

MMS Content Checksum

Lists each individual content checksum list that you created. On this page, you can edit, delete or create a
content checksum list.

Create New

Creates a new MMS content checksum list. When you select Create New,
you are automatically redirected to the New List. This page provides a
name field and comment field. You must enter a name to go to MMS
Content Checksum Settings page.

Edit Modifies settings to a MMS content checksum. When you select Edit, you
are automatically redirected to the MMSContent Checksum Settings page.

Delete

Removes an MMS content checksum from the page.

To remove multiple content checksum lists from within the list, on the MMS
Content Checksum page, in each of the rows of the content checksum lists
you want removed, select the check box and then select Delete.

To remove all content checksum lists from list, on the MMSContent
Checksum page, select the check box in the check box column and then
select Delete.

Name The name of the MMS content checksum list that you created.

# Entries The number of checksums that are included in the content checksum list.
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MMS Profiles The MMS profile or profiles that have the MMS content checksum list
applied. For example if two different MMS profiles use this content
checksum list, they will both be listed here.

Comments A description given to the MMS content checksum.

Ref. Displays the number of times the object is referenced to other objects. For
example, av_1 profile is applied to a security policy; on the Profile page
(Security Profiles > AntiVirus > Profiles), 1 appears in Ref. .

To view the location of the referenced object, select the number in Ref.,
and the Object Usage window appears displaying the various locations of
the referenced object.

To view more information about how the object is being used, use one of
the following icons that is available within the Object Usage window:

•  View the list page for these objects – automatically redirects you to
the list page where the object is referenced at.

•  Edit this object – modifies settings within that particular setting that the
object is referenced with. For example, av_1 profile is referenced with a
security policy and so, when this icon is selected, the user is redirected to
the Edit Policy page.

•  View the details for this object – table, similar to the log viewer table,
contains information about what settings are configured within that
particular setting that the object is referenced with. For example, av_1
profile is referenced with a security policy, and that security policy’s settings
appear within the table.

Notification List
The Notification List menu allows you to configure a list of viruses. This virus list provides a list for scanning
viruses in MMSmessages. You can use one virus list in multiple MMS profiles, and configure multiple virus lists.

Notification list configuration settings

The following are notification list configuration settings in Security Profiles > Notification List.

Notification List

Lists all the notification lists that you created. On this page you can edit, delete or create a new notification
list.

Create New
Creates a new notification list. When you select Create New, you are
automatically redirected to the New List page. You must enter a name to
go to the Notification List Settings page.
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Edit Modifies settings within the notification list. When you select Edit, you are
automatically redirected to the Notification List Settings page.

Delete

Removes a notification list from the list on the Notification List page.

To remove multiple notification lists from within the list, on the Notification
List page, in each of the rows of the notification lists you want removed,
select the check box and then select Delete.

To remove all notification lists from the list, on the Notification List page,
select the check box in the check box column and then select Delete.

Name The name of the MMS content checksum list that you created.

# Entries The number of checksums that are included in that content checksum list.

MMS Profiles The MMS profile or profiles that are associated with

Comments A description given to the MMS notification list.

Ref. Displays the number of times the object is referenced to other objects. For
example, av_1 profile is applied to a security policy; on the Profile page
(Security Profiles > Antivirus > Profiles), 1 appears in Ref. .

To view the location of the referenced object, select the number in Ref.,
and the Object Usage window appears displaying the various locations of
the referenced object.

To view more information about how the object is being used, use one of
the following icons that is available within the Object Usage window:

•  View the list page for these objects – automatically redirects you to
the list page where the object is referenced at.

•  Edit this object – modifies settings within that particular setting that the
object is referenced with. For example, av_1 profile is referenced with a
security policy and so, when this icon is selected, the user is redirected to
the Edit Policy page.

•  View the details for this object – table, similar to the log viewer table,
contains information about what settings are configured within that
particular setting that the object is referenced with. For example, av_1
profile is referenced with a security policy, and that security policy’s settings
appear within the table.

Notification List Settings

Provides settings for configuring a notification list, which is a list of viruses and is used for scanning viruses in
MMSmessages. This list is called the Antivirus Notification List in an MMS profile.
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Name If editing the name of a notification list, enter the new name in this field.
You must select OK to save the change.

Comments If you want to enter a comment, enter the comment in the field. You must
select OK to save the change.

Create New Creates a notification entry in the list. When you select Create New, you
are automatically redirected to the New Entry page.

Edit Modifies settings within a notification list. When you select Edit, you are
automatically redirected to the Edit Entry page.

Delete Removes a notification entry from the list on the page.

To remove multiple notification entries from within the list, on the
Notification List Settings page, in each of the rows of the entries you want
removed, select the check box and then select Delete.

To remove all notification entries from the list, on the Notification List
Settings page, select the check box in the check box column and then
select Delete.

Enable Enables a notification entry that is disabled.

Disable Disables a notification entry so that it is not active and available for use, but
it is not deleted.

Remove All Entries Removes all notification entries that are listed on the Notification List
Settings page.

Enable Displays whether or not the checksum is enabled.

Virus Name/Profile The name of the virus that was added to the list.

Entry Type The type of match that will be used to match the virus stated in the
notification list to the actual virus that is found.

New Entry page

Virus Name/Profile Enter the virus name.

Entry Type Select the type of match that will be used to match the virus stated in the
notification list to the actual virus that is found.

Enable Select to enable the virus in the list.

Message Flood
The convenience offered by MM1 and MM4 messaging can be abused by users sending spam or attempting to
overload the network with an excess of messages. MMS flood prevention can help prevent this type of abuse. A
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message flood occurs when a single subscriber sends a volume of messages that exceed the flood threshold that
you set. The threshold defines the maximum number of messages allowed, the period during which the
subscriber sent messages are considered, and the length of time the sender is restricted from sending messages
after a flood is detected. For example, for the first threshold you may determine that any subscriber who sends
more than 100 MM1 messages in an hour (60 minutes) will have all outgoing messages blocked for 30 minutes.

Action Description

Log Add a log entry indicating that a message flood has occurred. You must
also enable logging by going to Security Profiles > MMS Profile,
<applicable profile> > Logging > MMS Scanning > Bulk
Messages, and toggling on the checkbox.

DLP Archive

Save the first message to exceed the flood threshold, or all the
messages that exceed the flood threshold, in the DLP archive. DLP
archiving flood messages may not always produce useful results. Since
different messages can be causing the flood, reviewing the archived
messages may not be a good indication of what is causing the problem
since the messages could be completely random.

All messages All the messages that exceed the flood threshold will be saved in the
DLP archive.

First message only

Save only the first message to exceed the flood threshold in the DLP
archive. Other messages in the flood are not saved. For message floods
this may not produce much useful information since a legitimate
message could trigger the flood threshold.

Intercept Messages that exceed the flood threshold are passed to the recipients,
but if quarantine is enabled for intercepted messages, a copy of each
message will also quarantined for later examination. If the quarantine of
intercepted messages is disabled, the Intercept action has no effect.

Block

Messages that exceed the flood threshold are blocked and will not be
delivered to the message recipients. If quarantine is enabled for blocked
messages, a copy of each message will quarantined for later
examination.

Alert Notification If the flood threshold is exceeded, the Carrier-enabled FortiGate unit
will send an MMS flood notification message.

In the web-based manager when Alert Notification is selected it
displays the fields to configure the notification.

Flood protection for MM1 messages prevents your subscribers from sending too many messages to your MMSC.
Configuring flood protection for MM4 messages prevents another service provider from sending too many
messages from the same subscriber to your MMSC.

Message flood configuration settings

The following are message flood configuration settings in Security Profiles > Message Flood.
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Message Flood

Lists the large amount of messages that are being sent to you from outside sources.

Delete

Removes messages from the list.

To remove multiple messages from within the list, on the Message Flood
page, in each row of the messages you want removed, select the check box
and then select Delete.

To remove all messages from the list, on the Message Flood page, select
the check box in the check box column and then select Delete.

Remove All Entries Removes all messages from the list.

Protocol Sorts/filters by the protocol used.

MMS Profile Sorts/filters by the MMS profile that is used.

Sender Sorts/filters by the sender’s email address.

Level Sorts/filters by he level of severity of the message.

Count The count column can be up or down and these settings can be turned off
by selecting beside the column’s name.

Window Size (minutes) The time in minutes.

Timer (minutes:seconds) The time in seconds and in minutes. The timer column can be up or down
and these settings turned off by selecting beside the column’s name.

Page Controls Use to navigate through the list.

Duplicate Message
Duplicate message protection for MM1 messages prevents multiple subscribers from sending duplicate
messages to your MMSC. Duplicate message protection for MM4 messages prevents another service provider
from sending duplicate messages from the same subscriber to your MMSC.

The unit keeps track of the sent messages. If the same message appears more often than the threshold value
that you have configured, action is taken. Possible actions are logging the duplicate messages, blocking or
intercepting them, archiving, and sending an alert to inform an administrator that duplicate messages are
occurring.

Duplicate message configuration settings

View duplicate messages in Security Profiles > Duplicate Message.
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Duplicate Message

Lists duplicates of messages that were sent to you.

Delete

Removes a message from the list.

To remove multiple duplicate messages from within the list, on the
Message Flood page, in each row of the messages you want removed,
select the check box and then select Delete.

To remove all duplicate messages from the list, on the Message Flood
page, select the check box in the check box column and then select Delete.

Page Controls Use to navigate through the list.

Remove All Entries Removes all duplicate messages from the list.

Protocol Sorts/filters by the protocol used.

MMS Profile Sorts/filters by the MMS profile that logs the detection.

Checksum Sorts/filters by the checksum of the MMSmessage.

Level Sorts/filters by he level of severity of the message.

Count Displays the number of messages in the last window of time.

Window Size (minutes) The period of time during which a message flood will be detected if the
Message Flood Limit is exceeded.

Timer (minutes:seconds) Either the time left in the window if the message is unflagged, or the time
until the message will be unflagged if it is already flagged.

Carrier Endpoint Filter Lists
A carrier endpoint filter list contains carrier endpoint patterns. A pattern can match one carrier endpoint or can use
wildcards or regular expressions to match multiple carrier endpoints. For each pattern, you select the action that
the unit takes on a message when the pattern matches a carrier endpoint in the message. Actions include
blocking the message, exempting the message from MMS scanning, and exempting the message from all
scanning. You can also configure the pattern to intercept the message and content archive the message to a
FortiAnalyzer unit.

Carrier endpoint filter lists configuration settings

The following are Carrier endpoint filter list configuration settings in Security Profiles > Carrier Endpoint
Filter Lists.
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Carrier Endpoint Filter Lists

Lists all the endpoint filters that you created. On this page, you can edit, delete or create a new endpoint
filter list.

Create New
Creates a new endpoint filter list. When you select Create New, you are
automatically redirected to the New List page. You must enter a name to
go to the Carrier Endpoint Filter Lists Settings page.

Edit Modifies settings within an endpoint filter list in the list.

Delete

Removes an endpoint filter in the list.

To remove multiple endpoint filter lists from within the list, on the Carrier
Endpoint Filter List page, in each of the rows of the endpoint filter lists
you want removed, select the check box and then select Delete.

To remove all endpoint filter lists from the list, on the Carrier Endpoint
Filter List page, select the check box in the check box column and then
select Delete.

Name The name of the endpoint filter.

# Entries The number of carrier endpoint patterns in each carrier endpoint filter
list.

MMS Profiles The MMS profile that the carrier endpoint filter list is added to.

Comments A description about the endpoint filter.
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Ref. Displays the number of times the object is referenced to other objects.
For example, av_1 profile is applied to a security policy; on the Profile
page (Security Profiles > Antivirus > Profiles), 1 appears in Ref. .

To view the location of the referenced object, select the number in Ref.,
and the Object Usage window appears displaying the various locations
of the referenced object.

To view more information about how the object is being used, use one of
the following icons that is available within the Object Usage window:

•  View the list page for these objects – automatically redirects you to
the list page where the object is referenced at.

•  Edit this object – modifies settings within that particular setting that
the object is referenced with. For example, av_1 profile is referenced
with a security policy and so, when this icon is selected, the user is
redirected to the Edit Policy page.

•  View the details for this object – table, similar to the log viewer
table, contains information about what settings are configured within
that particular setting that the object is referenced with. For example,
av_1 profile is referenced with a security policy, and that security policy’s
settings appear within the table.

Carrier Endpoint Filter Lists Settings

Provides settings for configuring an endpoint filter.

Name The name you entered on the New List page, after selecting Create
New on the Carrier Endpoint Filter page.

Comments A description about the endpoint filter. You can add one here if you did
not enter one on the New List page.

Create New Creates a new endpoint filter list. When you select Create New, you are
automatically redirected to the New Entry page.

Edit Select to modify the settings of a pattern in the list.

Delete Select to remove a pattern in the list.

Enable Enables a disabled pattern in the list.

Disable Disables a pattern in the list.

Remove All Entries Removes all patterns in the list on the Carrier Endpoint Filter Lists
Settings page.

Enable Indicates whether or not the pattern is enabled.
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Pattern

Enter or change the pattern that FortiOS Carrier uses to match with
carrier endpoints. The pattern can be a single carrier endpoint or consist
of wildcards or Perl regular expressions that will match more than one
carrier endpoint. Set Pattern Type to correspond to the pattern that you
want to use.

Action Select the action taken by FortiOS Carrier for messages from a carrier
endpoint that matches the carrier endpoint pattern:

Pattern Type The type of pattern chosen.

New Entry page

Pattern

Enter or change the pattern that FortiOS Carrier uses to match with
carrier endpoints. The pattern can be a single carrier endpoint or consist
of wildcards or Perl regular expressions that will match more than one
carrier endpoint. Set Pattern Type to correspond to the pattern that you
want to use.

Action(s) Select the action taken by FortiOS Carrier for messages from
a carrier endpoint that matches the carrier endpoint pattern:

Action(s) can be:

l None
l Block
l Exempt from mass MMS
l Exempt from all scanning

Content Archive
MMSmessages from the carrier endpoint are delivered, the message
content is DLP archived according to MMSDLP archive settings.
Content archiving is also called DLP archiving.

Pattern Type Select a pattern type as one of Single Carrier Endpoint, Wildcard or
Regular Expression.

Wildcard and Regular Expression will match multiple patterns where
Single Carrier Endpoint matches only one.

Enable Select to enable this carrier endpoint filter pattern.

Message flood protection
The convenience offered by MM1 and MM4 messaging can be abused by users sending spam or attempting to
overload the network with an excess of messages. MMS flood prevention can help prevent this type of abuse.

Overview

Flood protection for MM1 messages prevents your subscribers from sending too many messages to your MMSC.
Configuring flood protection for MM4 messages prevents another service provider from sending too many
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messages from the same subscriber to your MMSC.

MM1 and MM4 flood protection

The FortiOS Carrier unit keeps track of the number of messages each subscriber sends for the length of time you
specify. If the number of messages a subscriber sends exceeds the threshold, a configured action is taken.
Possible actions are logging the flood, blocking or intercepting messages in the flood, archiving the flood
messages, and sending an alert message to inform the administrator that the flood is occurring.

You can create three different thresholds to take different levels of action at different levels of activity.

With this highly configurable system, you can prevent subscribers from sending more messages than you
determine is acceptable, or monitor anyone who exceeds the thresholds.

Setting message flood thresholds

Amessage flood occurs when a single subscriber sends a volume of messages that exceeds the flood threshold
you set. The threshold defines the maximum number of messages allowed, the period during which the
subscriber sent messages are considered, and the length of time the sender is restricted from sending messages
after a flood is detected.
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If a subscriber exceeds the message flood threshold and is blocked from sending more messages, any further
attempts to send messages will re-start the block period. You must also enable logging forMMS Scanning >
Bulk Messages in the Logging section of the MMS protection profile.

A subscriber is still able to receive messages while they are blocked from sending
messages.

Example

For example, for the first threshold you may determine that any subscriber who sends more than 100 MM1
messages in an hour (60 minutes) will have all messages blocked for half an hour (30 minutes).

Using this example, if the subscriber exceeds the flood threshold, they are blocked from sending message for 30
minutes. If the subscriber tries to send any message after 15 minutes, the message will be blocked and the block
period will be reset again to 30 minutes. The block period must expire with no attempts to send a message. Only
then will the subscriber be allowed to send more messages.

To configure MM1 message flood threshold - web-based manager

1. Go to Security Profiles > MMS Profile.
2. Select Create New.
3. Enter MM1 flood for Profile Name.
4. ExpandMMS Bulk Email Filtering Detection.
5. Enter the following information, and select OK.

MM1 (first column)

Enable Enable

Message Flood Window 60 minutes

Message Flood Limit 100

Message Flood Block Time 30 minutes

Message Flood Action Block

To configure MM1 message flood threshold - CLI

config firewall mms-profile
edit profile_name

config flood mm1
set status1 enable
set window1 60
set limit1 100
set action1 block
set block-time1 30

end
end
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The threshold values that you set for your network will depend on factors such as how busy your network is and
the kinds of problems that your network and your subscribers encounter. For example, if your network is not too
busy you may want to set message flood thresholds relatively high so that only an exceptional situation will
exceed a flood threshold. Then you can use log messages and archived MMSmessages to determine what
caused the flood.

If your subscribers are experiencing problems with viruses that send excessive amounts of messages, you may
want to set thresholds lower and enable blocking to catch problems as quickly as possible and block access to
keep the problem from spreading.

Flood actions

When the Carrier-enabled FortiGate unit detects a message flood, it can take any combination of the five actions
that you can configure for the flood threshold. For detailed options, see Message Flood.

Notifying administrators of floods

You can configure alert notifications for message floods by selecting the Alert Notification message flood action.

The FortiOS Carrier unit sends alert notifications to administrators using the MM1, MM3, MM4, or MM7 content
interface. To send an alert notification you must configure addresses and other settings required for the content
interface.

For example, to send notifications using the MM1 content interface you must configure a source MSISDN,
hostname, URL, and port to which to send the notification. You can also configure schedules for when to send the
notifications.

Finally you can add multiple MSISDN numbers to the MMS protection profile and set which flood thresholds to
send to each MSISDN.

Example — three flood threshold levels with different actions for each threshold

You can set up to three threshold levels to take different actions at different levels of activity.

The first example threshold records log messages when a subscriber’s handset displays erratic behavior by
sending multiple messages using MM1 at a relatively low threshold. The erratic behavior could indicate a problem
with the subscriber’s handset. For example, you may have determined for your network that if a subscriber sends
more the 45 messages in 30 minutes that you want to record log messages as a possible indication or erratic
behavior.

From the web-based manager in an MMS profile set message Flood Threshold 1 to:

Enable Selected

Message Flood Window 30 minutes

Message Flood Limit 45

Message Flood Action Log

From the CLI:

config firewall mms-profile
edit profile_name

config flood mm1
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set status1 enable
set window1 30
set limit1 45
set action1 log

end
end

Set a second higher threshold to take additional actions when a subscriber sends more that 100 messages in 30
minutes. Set the actions for this threshold to log the flood, archive the message that triggered the second
threshold, and block the sender for 15 minutes.

From the web-based manager in an MMS profile set message Flood Threshold 2 to:

Enable Selected

Message Flood Window 30 minutes

Message Flood Limit 100

Message Block Time 15 minutes

Message Flood Action Log, DLP archive First message only, Block

From the CLI:

config firewall mms-profile
edit profile_name

config flood mm1
set status2 enable
set window2 30
set limit2 100
set action2 block log archive-first
set block-time2 15

end
end

Set the third and highest threshold to block the subscriber for an extended period and sand an administrator alert
if the subscriber sends more than 200 messages in 30 minutes. Set the actions for this threshold to block the
sender for four hours (240 minutes), log the flood, archive the message that triggered the third threshold, and
send an alert to the administrator.

From the web-based manager in an MMS profile set message Flood Threshold 3 to:

Enable Selected

Message Flood Window 30 minutes

Message Flood Limit 200

Message Block Time 240 minutes

Message Flood Action Log, Block, Alert Notification
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Because you have selected the Alert Notification action you must also configure alert notification settings. For
this example, the source MSISDN is 5551234—telephone number 555-1234. When administrators receive MMS
messages from this MSIDSN they can assume a message flood has been detected.

In this example, alert notifications are sent by the FortiOS Carrier unit to the MMSC using MM1. The host name
of the MMSC is mmscexample, the MMSC URL is /, and the port used by the MMSC is 80. In this example, the
alert notification window starts at 8:00am and extends for eight hours on weekdays (Monday-Friday) and the
minimum interval between message flood notifications is two hours.

Source MSISDN 5551234

Message Protocol MM1

Hostname mmscexample

URL /

Port 80

Notifications Per Second
Limit 0

Window Start Time 8:00

Window Duration 8:00

Day of Week Mon, Tue, Wed, Thu, Fri, Sat

Interval 2 hours

From the CLI:

config firewall mms-profile
edit profile_name

config notification alert-flood-1
set alert-src-msisdn 5551234
set msg-protocol mm1
set mmsc-hostname mmscexample
set mmsc-url /
set mmsc-port 80
set rate-limit 0
set tod-window-start 8:00
set tod-window-duration 8:00
set days-allowed monday tuesday wednesday thursday friday
set alert-int 2
set alert-int-mode hours

end

You must also add the MSISDNs of the administrators to be notified of the message flood. In this example, the
administrator flood threshold 3 alert notifications are sent to one administrator with MSISDN 5554321.

To add administrator’s MSISDNs for flood threshold 3 from the web-based manager when configuring a
protection profile, select MMS Bulk Email Filtering Detection > Recipient MSISDN > Create New.
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MSISDN 5554321

Flood Level 3 Select

From the CLI:

config firewall mms-profile
edit profile_name

config notif-msisdn
edit 5554321

set threshold flood-thresh-3
end

end

Notifying message flood senders and receivers

The FortiOS Carrier unit does not send notifications to the sender or receiver that cause a message flood. If the
sender or receiver is an attacker and is explicitly informed that they have exceeded a message threshold, the
attacker may try to determine the exact threshold value by trial and error and then find a way around flood
protection. For this reason, no notification is set to the sender or receiver.

However, FortiOS Carrier does have replacement messages for sending reply confirmations to MM1 senders and
receivers and for MM4 senders for blocked messages identified as message floods. For information about how
FortiOS Carrier responds when message flood detection blocks a message, see and MMS duplicate messages
and message floods.

Responses to MM1 senders and receivers

When the FortiOS Carrier unit identifies an MM1 message sent by a sender to an MMSC as a flood message and
blocks it, the FortiOS Carrier unit returns a message submission confirmation (m-send.conf) to the sender —
otherwise the sender’s handset would keep retrying the message. The m-send.conf message is sent only
when the MM1 message flood action is set to Block. For other message flood actions the message is actually
delivered to the MMSC and the MMSC sends the m-send.conf message.

You can customize the m-send.conf message by editing theMM1 send-conf flood messageMM1
replacement message (from the CLI the mm1-send-conf-flood replacement message). You can customize
the response status and message text for this message. The default response status is “Content not accepted”.
To hide the fact that FortiOS Carrier is responding to a flood, you can change the response status to “Success”.
The default message text informs the sender that the message was blocked. You could change this to something
more generic.

For example, the following command sets the submission confirmation response status to “Success” and
changes the message text to “Message Sent OK”:

config system replacemsg mm1 mm1-send-conf-flood
set rsp-status ok
set rsp-text “Message Sent OK”

end

When the FortiOS Carrier unit identifies an MM1 message received by a receiver from an MMSC as a flood
message and blocks it, the FortiOS Carrier unit returns a message retrieval confirmation (m-retrieve.conf) to the
sender (otherwise the sender’s handset would keep retrying the message). The m-retrieve.conf message is sent
only when the MM1 message flood action is set to Block. For other message flood actions the message is
actually delivered to the receiver, so the MMSC sends the m-retrieve.conf message.
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You can customize the m-retrive.conf message by editing theMM1 retrieve-conf flood messageMM1
replacement message (from the CLI the mm1-retr-conf-flood replacement message). You can customize
the class, subject, and message text for this message.

For example, you could use the following command make the response more generic:

config system replacemsg mm1 mm1-retr-conf-flood
set subject “Message blocked”
set message “Message temporarily blocked by carrier”

end

Forward responses for MM4 message floods

When the FortiOS Carrier unit identifies an MM4 message as a flood message and blocks it, the FortiOS Carrier
unit returns a message forward response (MM4_forward.res) to the forwarding MMSC (otherwise the forwarding
MMSC would keep retrying the message). The MM4_forward.res message is sent only when the MM4 message
flood action is set to Block and the MM4-forward.req message requested a response. For more information, see
and MMS duplicate messages and message floods.

You can customize the MM4_forward.res message by editing theMM4 flood messageMM4 replacement
message (from the CLI the mm4-flood replacement message). You can customize the response status and
message text for this message. The default response status is “Content not accepted” (err-content-not-
accept). To hide the fact that the FortiOS Carrier unit is responding to a flood, you can change the response
status to “Success”. The default message text informs the sender that the message was blocked. You could
change this to something more generic.

For example, the following command sets the submission confirmation response status to “Success” and
changes the message text to “Message Sent OK” for the MM4 message forward response

config system replacemsg mm4 mm4-flood
set rsp-status ok
set rsp-text “Message Forwarded OK”

end

Viewing DLP archived messages

If DLP Archive is a selected message flood action, the messages that exceed the threshold are saved to the
MMSDLP archive. The default behavior is to save all of the offending messages, but you can configure the DLP
archive setting to save only the first message that exceeds the threshold. This still provides a sample of the
offending messages without requiring as requiring as much storage.

To select only the first message in a flood for DLP archiving - web-based manager

1. Go to Security Profiles > MMS Profile.
2. Edit an existing MMSProfile.
3. Expand theMMS Bulk Email Filtering Detection section, theMessage Flood subsection, and the desired

Flood Threshold subsection.
4. Next to DLP Archive, select First message only from the drop down menu.
5. Select OK.

Order of operations: flood checking before duplicate checking

Although duplicate checking involves only examination and comparison of message contents and not the sender
or recipient, and flood checking involves only totaling the number of messages sent by each subscriber regardless
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of the message content, there are times when a selection of messages exceed both flood and duplicate
thresholds.

The Carrier-enabled FortiGate unit checks for message floods before checking for duplicate messages. Flood
checking is less resource-intensive and if the flood threshold invokes a Block action, the blocked messages are
stopped before duplicate checking occurs. This saves both time and FortiOS Carrier system resources.

The duplicate scanner will only scan content. It will not scan headers. Content must be
exactly the same. If there is any difference at all in the content, it will not be
considered a duplicate.

Bypassing message flood protection based on user’s carrier endpoints

You can use carrier endpoint filtering to exempt MMS sessions from message flood protection. Carrier endpoint
filtering matches carrier endpoints in MMS sessions with carrier endpoint patterns.

If you add a carrier endpoint pattern to a filter list and set the action to exempt from mass MMS, all messages
from matching carrier endpoints bypass message flood protection. This allows legitimate bulk messages, such as
system outage notifications, to be delivered without triggering message flood protection.

For more information on carrier endpoints, see the User Authentication chapter of the FortiOS Handbook.

Configuring message flood detection

To have the Carrier-enabled FortiGate unit check for message floods, you must first configure the flood threshold
in an MMS profile, select the MMS profile in a security policy. All the traffic examined by the security policy will be
checked for message floods according to the threshold values you set in the MMS profile.

Configure the MMS profile - web-based manager

1. Go to Firewall Objects > MMS Profile.
2. If you are editing an MMS profile, select the Edit icon of the MMS profile.

If you are creating a new MMS profile, select Create New and enter a profile name.

3. ExpandMMS Bulk Email Filtering Detection.
4. ExpandMessage Flood.
5. Expand Flood Threshold 1.
6. Select the Enable check box for MM1 messages, MM4 messages, or both.
7. In theMessage Flood Window field, enter the length of time the Carrier-enabled FortiGate unit will keep track

of the number of messages each subscriber sends.
If the Carrier-enabled FortiGate unit detects the quantity of messages specified in theMessage
Flood Limit sent during the number of minutes specified in theMessage Flood Window, a
message flood is in progress.

8. In theMessage Flood Limit field, enter the number of messages required to trigger the flood.
9. In theMessage Flood Block Time field, enter the length of time a user will be blocked from sending messages

after causing the message flood.
10. Select the message flood actions the Carrier-enabled FortiGate unit will take when the message flood is detected.
11. Select OK.
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Configure the security policy - web-based manager

1. Go to Policy.
2. Select the Edit icon of the security policy that controls the traffic in which you want to detect message floods.
3. Select theMMS Profile check box to enable the use of a protection profile.
4. Select the MMS protection profile from the list.
5. Select OK.

Sending administrator alert notifications

When message floods are detected, the Carrier-enabled FortiGate unit can be configured to notify you
immediately with an MMSmessage. Enable this feature by selecting Alert Notification in the message flood
action. Each message flood threshold can be configured separately.

Configuring how and when to send alert notifications

You can configure different alert notifications for MM1 and MM4 message floods. You can configure the FortiOS
Carrier unit to send these alert notifications using the MM1, MM3, MM4, or MM7 content interface. Each of these
content interfaces requires alert notification settings that the FortiOS Carrier unit uses to communicate with a
server using the selected content interface.

For the MM1 content interface you require:

l The hostname of the server
l The URL of the server (usually “/”)
l The server port (usually 80)

For the MM3 and MM4 content interfaces you require:

l The hostname of the server
l The server port (usually 80)
l The server user domain

For the MM7 content interface you require:

l The message type
l submit.REQ to send a notification message to the sender in the form of a submit request. The message goes from

a VAS application to the MMSC.
l deliver.REQ to send a notification message to the sender in the form of a deliver request. The message goes from

the MMSC to a VAS application.
l The hostname of the server
l The URL of the server (usually “/”)
l The server port (usually 80)
l A user name and password to connect to the server
l The value-added-service-provider (VASP) ID
l The value-added-service (VAS) ID

For more information, see MMS notifications.
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To configure administrator alert notifications - web-based manager

1. Go to Firewall Objects > MMS Profile and edit or add a new MMS protection profile.
2. ExpandMMS Bulk Email Filtering Detection.

There are three message flood thresholds.

3. Expand the threshold that you want to configure alert notification for.
4. ForMessage Flood Action, select the Alert Notification check box. Alert notification options appear.
5. For the Source MSISDN, enter the MSISDN from which the alert notification message will be sent.
6. Select the Message Protocol the alert notification will use: MM1, MM3, MM4, orMM7.
7. Add the information required by FortiOS Carrier to send messages using the selected message protocol:
8. ForNotifications Per Second Limit, enter the number of notifications to send per second.

Use this setting to reduce control the number of notifications sent by the FortiOS Carrier unit. If you
enter zero (0), the notification rate is not limited.

9. If required, changeWindow Start Time andWindow Duration configure when the FortiOS Carrier unit sends
alert notifications.
By default, notifications are sent at any time of the day. You can change the Window Start Time if you
want to delay sending alert messages. You can also reduce the Window Duration if you want to stop
sending alert notifications earlier.

For example, you might not want FortiOS Carrier sending notifications except during business hours.
In this case the Window Start Time could be 9:00 and the Window Duration could be 8:00 hours.

You can set different alert notifications for each message threshold. For example, you could limit the
message window for lower thresholds and set it to 24 hours for higher thresholds. This way
administrators will only receive alert notifications outside of business hours for higher thresholds.

10. ForDay of Week, select the days of the week to send notifications.
For example, you may only want to send alert notifications on weekends for higher thresholds.

11. In the Interval field, enter the maximum frequency that alert notification messages will be sent, in minutes or
hours.
All alerts occurring during the interval will be included in a single alert notification message to reduce
the number of alert messages that are sent.

Configuring who to send alert notifications to

In each MMS protection profile you add a list of recipient MSISDNs. For each of these MSISDNs you select the
message flood threshold that triggers sending notifications to this MSISDN.

To configure the alert notification recipients - web-based manager

1. Go to Firewall Objects > MMS Profile.
2. Select the Edit icon of the MMS profile in which you want to configure the alert notification recipients.
3. ExpandMMS Bulk Email Filtering Detection.
4. Expand Recipient MSISDN.
5. Select Create New.
6. In the New MSISDN window, enter the MSISDN to use for flood threshold alert notification.
7. Select the duplicate thresholds at which to send alert notifications to the MSISDN.
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For the flood threshold to be able to send an alert notification to the MSISDN, the alert
notification action must be enabled and configured within the flood threshold.

Duplicate message protection
The convenience offered by MM1 and MM4 messaging can be abused by users sending spam or other unwanted
messages. Often, the same message will be sent by multiple subscribers. The message can be spam, viral
marketing, or worm-generated messages. MMS duplicate prevention can help prevent this type of abuse by
keeping track of the messages being sent.

Overview

Duplicate message protection for MM1 messages prevents multiple subscribers from sending duplicate
messages to your MMSC. Duplicate message protection for MM4 messages prevents another service provider
from sending duplicate messages from the same subscriber to your MMSC. This can help prevent a potential
flood that would otherwise become widespread between carriers.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

819



MMSConfiguration Chapter 7 - FortiOS Carrier

MM1 and MM4 duplicate message protection

The FortiOS Carrier unit keeps track of the sent messages. If the same message appears more often than the
threshold value you configure, then action is taken. Possible actions are logging the duplicates, blocking or
intercepting duplicate messages, archiving the duplicate messages, and sending an alert to inform an
administrator that duplicates are occurring.

With this highly configurable system, you can prevent the transmission of duplicate messages when there are
more than you determine is acceptable.

For detailed configuration options, see Duplicate Message.

Using message fingerprints to identify duplicate messages

The Carrier-enabled FortiGate unit detects duplicates by keeping a record of all the messages travelling on the
network and comparing new messages to those that have already been sent.
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Rather than save the messages, the FortiOS carrier creates a checksum using the message body and subject.
This serves as a fingerprint to identify the message. If another message with the same message body and
subject appears, the fingerprint will also be the same and the Carrier-enabled FortiGate unit will recognize it as a
duplicate.

By creating and saving message fingerprints instead of saving the messages, the Carrier-enabled FortiGate unit
can save resources and time.

Messages from any sender to any recipient

Duplicate message detection will detect duplicate messages regardless of the sender or recipient. To do this,
message fingerprints are generated using only the message body and subject. The sender, recipient, and other
header information is not included.

If multiple messages appear with the same subject and message body, the Carrier-enabled FortiGate unit will
recognize them as being the same.

Setting duplicate message thresholds

The FortiOS Carrier recognizes all duplicate messages, but it will take action when it detects a volume of
duplicate messages that exceed the duplicate threshold you set. The threshold defines the maximum number of
duplicate messages allowed, the period during which the messages are considered, and the length of time the
duplicate message can not be sent by anyone.

For example, you may determine that once a duplicate message is sent more than 300 times in an hour, any
attempt to send the same duplicate message will be blocked for 30 minutes.

If a particular duplicate message exceeds the duplicate message threshold and is blocked, any further attempts
to send the same message will re-start the block period.

Using the example above, if the duplicate message count exceeds the duplicate threshold, any attempt to send a
copy of the duplicate message will be blocked for 30 minutes. If a subscriber tries to send a copy of the message
after waiting 15 minutes, the message will be blocked and the block period will be reset to 30 minutes. The block
period must expire with no attempts to send a duplicate message. Only then will a subscriber be allowed to send
the message. Non-duplicate messages will not reset the block period.

Duplicate message actions

When the Carrier-enabled FortiGate unit detects that a duplicate message has exceeded duplicate threshold, it
can take any combination of the five actions you configure for the duplicate threshold.

Action Description

Log Add a log entry indicating that a duplicate message event has occurred.
You must also enable logging forMMS Scanning > Bulk Messages
in the Logging section of the MMS protection profile.

DLP Archive
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Action Description

All messages Save all the messages that exceed the duplicate threshold in the DLP
archive.

First message only
Save the first message to exceed the duplicate threshold in the DLP
archive. Subsequent messages that exceed the duplicate threshold will
not be saved.

Intercept Messages that exceed the duplicate threshold are passed to the
recipients, but if quarantine is enabled for intercepted messages, a copy
of each message is also quarantined for later examination. If the
quarantine of intercepted messages is disabled, the Intercept action
has no effect.

Block

Messages that exceed the duplicate threshold are blocked and will not
be delivered to the message recipients. If quarantine is enabled for
blocked messages, a copy of each blocked message is quarantined for
later examination.

Alert Notification If the duplicate threshold is exceeded, the Carrier-enabled FortiGate
unit will send an MMS duplicate message notification message.

Notifying duplicate message senders and receivers

The FortiOS Carrier unit does not send notifications to the sender or receiver of duplicate messages. If the sender
or receiver is an attacker and is explicitly informed that they have exceeded a message threshold, the attacker
may try to determine the exact threshold value by trial and error and then find a way around duplicate message
protection. For this reason, no notification is set to the sender or receiver.

However, the FortiOS Carrier unit does have replacement messages for sending reply confirmations to MM1
senders and receivers and for MM4 senders for blocked messages identified as duplicate messages. For
information about how FortiOS Carrier responds when message flood detection blocks a message, see and MMS
duplicate messages and message floods.

Responses to MM1 senders and receivers

When the FortiOS Carrier unit identifies an MM1 message sent by a sender to an MMSC as a duplicate message
and blocks it, the FortiOS Carrier unit returns a message submission confirmation (m-send.conf) to the sender
(otherwise the sender’s handset would keep retrying the message). The m-send.conf message is sent only when
the MM1 duplicate message action is set to Block. For other duplicate message actions the message is actually
delivered to the MMSC and the MMSC sends the m-send.conf message.

You can customize the m-send.conf message by editing theMM1 send-conf duplicate messageMM1
replacement message (from the CLI the mm1-send-conf-dupe replacement message). You can customize
the response status and message text for this message. The default response status is “Content not accepted”.
To hide the fact that the FortiOS Carrier unit is responding to a duplicate message, you can change the response
status to “Success”. The default message text informs the sender that the message was blocked. You could
change this to something more generic.

For example, the following command sets the submission confirmation response status to “Success” and
changes the message text to “Message Sent OK”:
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config system replacemsg mm1 mm1-send-conf-dupe
set rsp-status ok
set rsp-text “Message Sent OK”

end

When the FortiOS Carrier unit identifies an MM1 message received by a receiver from an MMSC as a duplicate
message and blocks it, the FortiOS Carrier unit returns a message retrieval confirmation (m-retrieve.conf) to the
sender (otherwise the sender’s handset would keep retrying). The m-retrieve.conf message is sent only when the
MM1duplicate message action is set to Block. For other message flood actions the message is actually
received by the receiver, so the MMSC sends the m-retrieve.conf message.

You can customize the m-retrive.conf message by editing theMM1 retrieve-conf duplicate messageMM1
replacement message (from the CLI the mm1-retr-conf-dupe replacement message). You can customize
the class, subject, and message text for this message.

For example, you could use the following command make the response more generic:

config system replacemsg mm1 mm1-retr-conf-dupe
set subject “Message blocked”
set message “Message temporarily blocked by carrier”

end

Forward responses for duplicate MM4 messages

When the FortiOS Carrier unit identifies an MM4 message as a duplicate message and blocks it, the FortiOS
Carrier unit returns a message forward response (MM4_forward.res) to the forwarding MMSC (otherwise the
forwarding MMSC would keep retrying the message). The MM4_forward.res message is sent only when the MM4
duplicate message action is set to Block and the MM4-forward.req message requested a response. For more
information, see and MMS duplicate messages and message floods.

You can customize the MM4_forward.res message by editing theMM4 duplicate messageMM4 replacement
message (from the CLI the mm4-dupe replacement message). You can customize the response status and
message text for this message. The default response status is “Content not accepted” (err-content-not-
accept). To hide the fact that the FortiOS Carrier unit is responding to a duplicate message, you can change the
response status to “Success”. The default message text informs the sender that the message was blocked. You
could change this to something more generic.

For example, the following command sets the submission confirmation response status to “Success” and
changes the message text to “Message Forwarded OK”:

config system replacemsg mm4 mm4-dupe
set rsp-status ok
set rsp-text “Message Forwarded OK”

end

Viewing DLP archived messages

If DLP Archive is a selected duplicate message action, the messages that exceed the threshold are saved to the
MMSDLP archive. The default behavior is to save all of the offending messages but you can configure the DLP
archive setting to save only the first message that exceeds the threshold. See Viewing DLP archived messages.

Order of operations: flood checking before duplicate checking

Although duplicate checking involves only examination and comparison of message contents and not the sender
or recipient, and flood checking involves only totalling the number of messages sent by each subscriber
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regardless of the message content, there are times when a selection of messages exceed both flood and
duplicate thresholds.

The Carrier-enabled FortiGate unit checks for message floods before checking for duplicate messages. Flood
checking is less resource-intensive and if the flood threshold invokes a Block action, the blocked messages are
stopped before duplicate checking occurs. This saves both time and FortiOS Carrier system resources.

Bypassing duplicate message detection based on user’s carrier endpoints

You can use carrier endpoint filtering to exempt MMS sessions from duplicate message detection. Carrier
endpoint filtering matches carrier endpoints in MMS sessions with carrier endpoint patterns. If you add a carrier
endpoint pattern to a filter list and set the action to exempt from mass MMS, all messages from matching carrier
endpoints bypass duplicate message detection. For more information about endpoints, see FortiOS Handbook
User Authentication guide.

Configuring duplicate message detection

To have the Carrier-enabled FortiGate unit check for duplicate messages, configure the duplicate threshold in an
MMS profile, and select the MMS profile in a security policy.

All traffic matching the security policy will be checked for duplicate messages according to the settings in the
MMS profile.

The duplicate scanner will only scan content. It will not scan headers. Content must be
exactly the same. If there is any difference at all in the content, it will not be
considered a duplicate.

The modular nature of the profiles allows you great flexibility in how you configure the scanning options. MMS
profiles can be used in any number of policies, with different GTP profiles.

In a complex configuration, there may be many security policies, each with a different MMS profile. For a simpler
network, you may have many security policies all using the same MMS profile.

Sending administrator alert notifications

When duplicate messages are detected, the Carrier-enabled FortiGate unit can be configured to notify you
immediately with an MMSmessage. Enable this feature by selecting Alert Notification in the duplicate message
action. Each duplicate message threshold can be configured separately.

Configuring how and when to send alert notifications

You can configure different alert notifications for MM1 and MM4 duplicate messages. You can configure the
FortiOS Carrier unit to send these alert notifications using the MM1, MM3, MM4, or MM7 content interface. Each
of these content interfaces requires alert notification settings that the FortiOS Carrier unit uses to communicate
with a server using the selected content interface.

For the MM1 content interface you require:

l The hostname of the server
l The URL of the server (usually “/”)
l The server port (usually 80)

For the MM3 and MM4 content interfaces you require:
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l The hostname of the server
l The server port (usually 80)
l The server user domain

For the MM7 content interface you require:

l The message type
l submit.REQ to send a notification message to the sender in the form of a submit request. The message goes from

a VAS application to the MMSC.
l deliver.REQ to send a notification message to the sender in the form of a deliver request. The message goes from

the MMSC to a VAS application.
l The hostname of the server
l The URL of the server (usually “/”)
l The server port (usually 80)
l A user name and password to connect to the server
l The value-added-service-provider (VASP) ID
l The value-added-service (VAS) ID

To configure administrator alert notifications - web-based manager

1. Go to Security Profiles > MMS Profile and edit or add a new MMS protection profile.
2. ExpandMMS Bulk Email Filtering Detection.

There are three duplicate message thresholds.

3. Expand the threshold that you want to configure alert notification for.
4. ForDuplicate Message Action, select the Alert Notification check box. Alert notification options appear.
5. For the Source MSISDN, enter the MSISDN from which the alert notification message will be sent.
6. Select the Message Protocol the alert notification will use: MM1, MM3, MM4, orMM7.
7. Add the information required by FortiOS Carrier to send messages using the selected message protocol:
8. ForNotifications Per Second Limit, enter the number of notifications to send per second.

Use this setting to reduce control the number of notifications sent by the FortiOS Carrier unit. If you
enter zero (0), the notification rate is not limited.

9. If required, changeWindow Start Time andWindow Duration configure when the FortiOS Carrier unit sends
alert notifications.
By default, notifications are sent at any time of the day. You can change the Window Start Time if you
want to delay sending alert messages. You can also reduce the Window Duration if you want to stop
sending alert notifications earlier.

For example, you might not want FortiOS Carrier sending notifications except during business hours.
In this case the Window Start Time could be 9:00 and the Window Duration could be 8:00 hours.

You can set different alert notifications for each message threshold. For example, you could limit the
message window for lower thresholds and set it to 24 hours for higher thresholds. This way
administrators will only receive alert notifications outside of business hours for higher thresholds.

10. ForDay of Week, select the days of the week to send notifications.
For example, you may only want to send alert notifications on weekends for higher thresholds.

11. In the Interval field, enter the maximum frequency that alert notification messages will be sent, in minutes or
hours.
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All alerts occurring during the interval will be included in a single alert notification message to reduce
the number of alert messages that are sent.

Configuring who to send alert notifications to

In each MMS protection profile you add a list of recipient MSISDNs. For each of these MSISDNs you select the
duplicate threshold that triggers sending notifications to this MSISDN.

To configure the alert notification recipients - web-based manager

1. Go to Security Profiles > MMS Profile.
2. Select the Edit icon of the MMS profile in which you want to configure the alert notification recipients.
3. ExpandMMS Bulk Email Filtering Detection.
4. Expand Recipient MSISDN.
5. Select Create New.
6. In the New MSISDN window, enter the MSISDN to use for duplicate threshold alert notification.
Select the duplicate thresholds at which to send alert notifications to the MSISDN.

For the duplicate threshold to be able to send an alert notification to the MSISDN, the
duplicate message threshold alert notification action must be enabled and configured.

Employing MMS Security features
FortiOS Carrier includes all the Security features of FortiOS with extra features specific to MMS carrier networks.

This section includes:

Why scan MMS messages for viruses and malware?

The requirement for scanning MM1 content comes from the fact that MMS is an increasingly popular technique
for propagating malware between mobile devices.

Example: COMMWARRIOR

This is a virus for Series 60 type cell phones, such as Nokia, operating Symbian OS version 6 [or higher]. The
object of the virus is to spread to other phones using Bluetooth and MMS as transport avenues. The targets are
selected from the contact list of the infected phone and also sought via Bluetooth searching for other Bluetooth-
enabled devices (phones, printers, gaming devices etc.) in the proximity of the infected phone.

This virus is more than a proof of concept - it has proven successfully its ability to migrate from a zoo collection to
being in-the-wild. Currently, this virus is being reported in over 18 different countries around Europe, Asia and
North America.

When the virus first infects a cell phone, a prompt is displayed asking the recipient if they want to install “Caribe”.
Symptoms of an infected phone may include rapid battery power loss due to constant efforts by the virus to
spread to other phones via a Bluetooth seek-and-connect outreach.

The following variants among others are currently scanned by the FortiOS Carrier devices, in addition to more
signatures that cover all known threats.
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l SymbOS/COMWAR.V10B!WORM
l Aliases: SymbOS.Commwarrior.B, SymbOS/Commwar.B, SymbOS/Commwar.B!wm, SymbOS/Commwar.B-net,

SymbOS/Commwarrior.b!sis, SymbOS/Comwar.B, SymbOS/Comwar.B!wm, SymbOS/Comwar.B-wm, SYMBOS_
COMWAR.B, SymbOS/Comwar.1.0.B!wormSYMBOS/COMWAR.V10B.SP!WORM [Spanish version]

l First Discovered In The Wild: July 04, 2007
l Impact Level: 1
l Virus Class: Worm
l Virus Name Size: 23,320
l SymbOS/Commwar.A!worm
l Aliases: Commwarrior-A, SymbOS.Commwarrior.A [NAV], SymbOS/Commwar.A-net, SymbOS/Commwar_

ezboot.A-ne, SymbOS/Comwar.A, SymbOS/Comwar.A-wm, SYMBOS_COMWAR.A [Trend]
l First Discovered In The Wild: May 16 2005
l Impact Level: 1
l Virus Class: Worm
l Virus Name Size: 27,936
l SymbOS/Commwarriie.C-wm
l Aliases: None
l First Discovered In The Wild: Oct 17 2005
l Impact Level: 1
l Virus Class: File Virus
l Virus Name Size: None

For the latest list of threats Fortinet devices detect, visit the FortiGuard Center.

MMS virus scanning

You can use MMS virus scanning to scan content contained within MMSmessages for viruses. FortiOS Carrier
virus scanning can be applied to the MM1, MM3, MM4, and MM7 interfaces to detect and remove content
containing viruses at many points in an MMS network. Perhaps the most useful interface to apply virus scanning
would be the MM1 interface to block viruses sent by mobile users before they get into the service provider
network.

To go to MMS virus scanning, go to Security Profiles MMS Profile, select an existing or create a new profile,
and expandMMS Scanning. See MMS scanning options.

This section includes:

l MMS virus monitoring
l MMS virus scanning blocks messages (not just attachments)
l Scanning MM1 retrieval messages
l Configuring MMS virus scanning
l Removing or replacing blocked messages
l Carrier Endpoint Block
l MMSContent Checksum
l Passing or blocking fragmented messages
l Client comforting
l Server comforting
l Handling oversized MMSmessages
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MMS virus monitoring

To enable MMS virus monitoring, expandMMS Scanning and enableMonitor only for the selected MMS
types.

This feature causes the FortiOS Carrier unit to record log messages when MMS scanning options find a virus,
match a file name, or match content using any of the other MMS scanning options. Selecting this option enables
reporting on viruses and other problems in MMS traffic without affecting users.

MMS virus scanning blocks messages (not just attachments)

To enable MMS virus scanning, expandMMS Scanning and enable Virus Scan for the selected MMS types.

Because MM1 and MM7 use HTTP, the oversize limits for HTTP and the HTTP antivirus port configurations also
apply to MM1 and MM7 scanning. See

MM3 and MM4 use SMTP and the oversize limits for SMTP and the SMTP antivirus port configurations also apply
to MM3 and MM4 scanning.

The message contents will be scanned for viruses, matched against the file extension blocking lists and scanned
for banned words. All these items will be configured via the standard GUI interfaces available for the other
protocols and will be controlled at the protection profile level with new options specifically for the MM1 messages.

The FortiOS Carrier unit extracts the sender’s Mobile Subscriber Integrated Services Digital Network Number
(MSISDN) from the HTTP headers if available. The POST payload will be sent to the scan units which will parse
the MMS content and scan each message data section. If any part of the data is to be blocked, the proxy will be
informed, the connection to the MMSC will be reset and the Carrier-enabled FortiGate unit will return an HTTP
200 OK message with an m-send-conf payload to the client to prevent a retry. Finally the appropriate logging,
alert, and replacement message events will be triggered.

For client notification, the x-mms-response-status and x-mms-response-text fields can also be
customized as required.

Scanning MM1 retrieval messages

To scan MM1 retrieval messages, expandMMS Scanning and select Scan MM1 message retrieval.

Select to scan message retrievals that use MM1. If you enable Virus Scan for all MMS interfaces, messages are
also scanned while being sent. In this case, you can disable MM1 message retrieval scanning to improve
performance.

Configuring MMS virus scanning

To configure MMS virus scanning, expandMMS Scanning and enable Virus Scan.

Once applied to a security policy, the MMS protection profile will then perform virus scans on all traffic accepted
by that policy.

Removing or replacing blocked messages

To remove blocked messages, expandMMS Scanning and select Remove Blocked for the selected MMS
types.
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Select Remove Blocked remove blocked content from each protocol and replace it with the replacement
message. If FortiOS Carrier is to preserve the length of the message when removing blocked content, as may
occur when billing is affected by the length of the message, select Constant.

If you only want to monitor blocked content, select Monitor Only.

Carrier Endpoint Block

A carrier endpoint defines a specific client on the carrier network. Typically the client IP address is used to identify
the client, however on a carrier network this may be impractical when the client is using a mobile device. Other
identifying information such as the MSIDSN number is used instead.

This information can be used to block a specific endpoint on the network. Reasons for blocking may include
clients whose accounts have expired, clients from another carrier, clients who have sent malicious content
(phishing, exploits, viruses, etc), or other violations of terms of use.

Enabling carrier endpoint blocking

To enable carrier endpoint blocking you first need to create a carrier endpoint filter list, and then enable it.

To enable carrier endpoint blocking - web-based manager

1. Create a carrier endpoint filter list.
2. Go to Security Profiles > MMS Profile.
3. Select Create New, or select an existing profile to edit and select Edit.
4. Expand MMSScanning.
5. Select one or more types of MMSmessaging to enable endpoint blocking on.
6. Select the carrier endpoint filter list to use in matching the endpoints to be blocked.

In MMSProfile, endpoints can only be blocked.

Create a carrier endpoint filter list

A carrier endpoint filter list contains one or more carrier endpoints to match. When used in MMS scanning entries
in the filter list that are matched are blocked.

You can configure multiple filter lists for different purposes and groups of clients, such as blocking clients, clients
with different levels of service agreements, and clients from other carriers. See Carrier endpoint filter lists
configuration settings.

To create a carrier endpoint filter list - web-based manager

1. Go to Security Profiles > Carrier Endpoint Filter Lists.
2. Select Create New.
3. Enter a descriptive name for the filter list, such as blocked_clients or CountryX_clients, and select OK.
4. Select Create New to add one or more entries to the list.
5. Select OK to return to display the list of filter lists.
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Configuring endpoint filter list entries

For each single endpoint or group of endpoints have part of their identifying information in common, you create
an entry in the endpoint filter list.

For example a blocked_clients filter list may include entries for single endpoints added as each one needs
to be blocked and a group of clients from a country that does not allow certain services.

To configure an endpoint filter list entry - web-based manager

1. Select Create New.
2. Enter the following information and select OK.

Name Name of endpoint filter list. Select this name in an MMS protection
profile.

Comments Optional description of the endpoint filter list.

Check/Uncheck All Select the check box to enable all endpoint patterns in the MMS filter
list.

Clear the check box to disable all entries on the MMS filter list.

You can also select or clear individual check boxes to enable or
disable individual endpoint patterns.

Pattern The pattern that FortiOS Carrier uses to match with endpoints. The
pattern can be a single endpoint or consist of wildcards or Perl regular
expressions that will match more than one endpoint. For more on
wildcard and regular expressions, see Using wildcards and Perl
regular expressions in the UTM guide.

Action Select the action taken by FortiOS Carrier for messages from a carrier
endpoint that matches the endpoint pattern:

None - No action is taken.

Block - MMSmessages from the endpoint are not delivered and
FortiOS Carrier records a log message.

Exempt from mass MMS - MMSmessages from the endpoint are
delivered and are exempt from mass MMS filtering. Mass MMS
filtering is configured in MMS protection profiles and is also called
MMSBulk Email Filtering and includes MMSmessage flood
protection and MMS duplicate message detection. A valid use of
mass MMSwould be when a service provider notifies customers of a
system-wide event such as a shutdown.

Exempt from all scanning - MMSmessages from the endpoint are
delivered and are exempt from all MMS protection profile scanning.
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Content Archive MMSmessages from the endpoint are delivered, the message
content is DLP archived according to MMSDLP archive settings.
Content archiving is also called DLP archiving.

Intercept MMSmessages from the endpoint are delivered. Based on the
quarantine configuration, attached files may be removed and
quarantined.

Pattern Type The pattern type:Wildcard, Regular Expression, or Single
Endpoint.

Enable Select to enable this endpoint filter pattern.

Blocking network access based on endpoints

You can use endpoint IP filtering to block traffic from source IP addresses associated with endpoints. You can
also configure FortiOS Carrier to record log messages whenever endpoint IP filtering blocks traffic. Endpoint IP
filtering blocks traffic at the IP level, before the traffic is accepted by a security policy.

To configure endpoint IP filtering, go to Security Profiles > IP Filter and add endpoints to the IP filter list. For
each endpoint you can enable or disable both blocking traffic and logging blocked traffic.

You cannot add endpoint patterns to the endpoint IP filter list. You must enter
complete and specific endpoints that are valid for your network.

The only action available is block. You cannot use endpoint IP filtering to exempt
endpoints from IP filtering or to content archive or quarantine communication
sessions.

FortiOS Carrier looks in the current user context list for the endpoints in the IP filter list and extracts the source IP
addresses for these endpoints. Then any communication session with a source IP address that matches one of
these IP addresses is blocked at the IP level, before the communication session is accepted by a security policy.

FortiOS Carrier dynamically updates the list of IP addresses to block as the user context list changes. Only these
updated IP addresses are blocked by endpoint IP filtering.

For information about the carrier endpoints and the user context list, including how entries are added to and
removed from this list.

MMS Content Checksum

The MMS content checksum feature attempts to match checksums of known malicious MMSmessages, and on
a successful match it will be blocked. The checksums are applied to each part of the message—attached files
and message body have separate checksums. These checksums are created with CRC-32, the same method as
FortiAnalyzer checksums.

For example, if an MMSmessage contains a browser exploit in the message body, you can add the checksum for
that message body to the list, and future occurrences of that exact message will be blocked. Content will be
replaced by the content checksum block notification replacement message for that type of MMSmessage, and if
it is enabled the event will be logged.
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One possible implementation would to configure all .sis files to be intercepted. When one is found to be infected
or malicious it would be added to the MMS content checksum list.

To use this feature a list of one or more malicious checksumsmust be created and then the feature is enabled
using that list. For a detailed list of options, see MMSContent Checksum.

To configure an MMS content checksum list

1. Go to Security Profiles > MMS Content Checksum.
2. Select Create New.
3. Enter a name for the list of checksums, and select OK.

You are taken to the edit screen for that new list.

4. Select Create New to add a checksum.
5. Enter the Name and Checksum, and select OK.

The checksum is added to the list.

To add more checksums to the list, repeat steps 4 and 5.

To remove a checksum from the list you can either delete the checksum or simply disable it and leave it in the list.

To enable MMS content checksums, expandMMS Scanning and select MMS Content Checksum for the
selected MMS types. Select the checksum list to match.

Passing or blocking fragmented messages

Select to pass fragmented MM3 and MM4 messages. Fragmented MMSmessages cannot be scanned for
viruses. If you do not select these options, fragmented MM3 and MM4 message are blocked.

The Interval is the time in seconds before client comforting starts after the download has begun, and the time
between sending subsequent data.

The Amount is the number of bytes sent by client or server comforting at each interval.

Client comforting

In general, client comting is available for for MM1 and MM7 messaging and provides a visual display of progress
for web page loading or HTTP or FTP file downloads. Client comforting does this by sending the first few packets
of the file or web page being downloaded to the client at configured time intervals so that the client is not aware
that the download has been delayed. The client is the web browser or FTP client. Without client comforting,
clients and their users have no indication that the download has started until the Carrier-enabled FortiGate unit
has completely buffered and scanned the download. During this delay users may cancel or repeatedly retry the
transfer, thinking it has failed.

The appearance of a client comforting message (for example, a progress bar) is client-dependent. In some
instances, there will be no visual client comforting cue.

During client comforting, if the file being downloaded is found to be infected, then the Carrier-enabled FortiGate
unit caches the URL and drops the connection. The client does not receive any notification of what happened
because the download to the client had already started. Instead the download stops, and the user is left with a
partially downloaded file.

If the user tries to download the same file again within a short period of time, then the cached URL is matched
and the download is blocked. The client receives the Infection cache message replacement message as a
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notification that the download has been blocked. The number of URLs in the cache is limited by the size of the
cache.

Client comforting can send unscanned (and therefore potentially infected) content to
the client. Only enable client comforting if you are prepared to accept this risk.
Keeping the client comforting interval high and the amount low will reduce the amount
of potentially infected data that is downloaded.

MM1 and MM7 client comforting steps

Since MM1 and MM7 messages use HTTP, MM1 and MM7 client comforting operates like HTTP client
comforting.

The following steps show how client comforting works for a download of a 1 Mbyte file with the client comforting
interval set to 20 seconds and the client comforting amount set to 512 bytes.

1. The client requests the file.
2. The Carrier-enabled FortiGate unit buffers the file from the server. The connection is slow, so after 20 seconds

about one half of the file has been buffered.
3. The Carrier-enabled FortiGate unit continues buffering the file from the server, and also sends 512 bytes to the

client.
4. After 20 more seconds, the FortiGate unit sends the next 512 bytes of the buffered file to the client.
5. When the file has been completely buffered, the client has received the following amount of data:

ca * (T/ci) bytes == 512 * (40/20) == 512 * 2 == 1024 bytes,

where ca is the client comforting amount, T is the buffering time and ci is the client comforting
interval.

6. If the file does not contain a virus, the Carrier-enabled FortiGate unit sends the rest of the file to the client. If the
file is infected, the FortiGate closes the data connection but cannot send a message to the client.

Server comforting

Server comforting can be selected for each protocol.

Similar to client comforting, you can use server comforting to prevent server connection timeouts that can occur
while waiting for FortiOS Carrier to buffer and scan large POST requests from slow clients.

The Interval is the time in seconds before client and server comforting starts after the download has begun, and
the time between sending subsequent data.

The Amount is the number of bytes sent by client or server comforting at each interval.

Handling oversized MMS messages

Select Block or Pass for files and email messages exceeding configured thresholds for each protocol.

The oversize threshold refers to the final size of the message, including attachments, after encoding by the client.
Clients can use a variety of encoding types; some result in larger file sizes than the original attachment. As a
result, a file may be blocked or logged as oversized even if the attachment is several megabytes smaller than the
oversize threshold.
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MM1 sample messages

Internet Protocol, Src Addr: 10.128.206.202 (10.128.206.202), Dst Addr: 10.129.192.190
(10.129.192.190)

Transmission Control Protocol, Src Port: 34322 (34322), Dst Port: http (80), Seq: 1, Ack:
1, Len: 1380

Source port: 34322 (34322)
Destination port: http (80)
Header length: 20 bytes
Flags: 0x0010 (ACK)
Window size: 24840
Checksum: 0x63c1 (correct)

HTTP proxy

Hypertext Transfer Protocol
POST / HTTP/1.1\r\n

Request Method: POST
Request URI: /
Request Version: HTTP/1.1

Host: 10.129.192.190\r\n
Accept: */*, application/vnd.wap.sic,application/vnd.wap.mms-message,text/x-

hdml,image/mng,image/x-mng,video/mng,video/x-mng,image/bmp\r\n
Accept-Charset: utf-8,*\r\n
Accept-Language: en\r\n
Content-Length: 25902\r\n
Content-Type: application/vnd.wap.mms-message\r\n
User-Agent: Nokia7650/1.0 SymbianOS/6.1 Series60/0.9 Profile/MIDP-1.0

Configuration/CLDC-1.0 UP.Link/6.2.1\r\n
x-up-devcap-charset: utf-8\r\n
x-up-devcap-max-pdu: 102400\r\n
x-up-uplink: magh-ip.mi.vas.omnitel.it\r\n
x-wap-profile: "http://nds.nokia.com/uaprof/N7650r200.xml"\r\n
x-up-subno: 1046428312-826\r\n
x-up-calling-line-id: 393475171234\r\n
x-up-forwarded-for: 10.211.4.12\r\n
x-forwarded-for: 10.211.4.12\r\n
Via: 1.1 magh-ip.mi.vas.omnitel.it\r\n
\r\n

Scan engine

MMS Message Encapsulation, Type: m-send-req
X-Mms-Message-Type: m-send-req (0x80)
X-Mms-Transaction-ID: 1458481935
X-Mms-MMS-Version: 1.0
From: <insert address>
To: 3475171234/TYPE=PLMN
X-Mms-Message-Class: Personal (0x80)
X-Mms-Expiry: 21600.000000000 seconds
X-Mms-Priority: Normal (0x81)
X-Mms-Delivery-Report: No (0x81)
X-Mms-Read-Report: No (0x81)
Content-Type: application/vnd.wap.multipart.related; start=<1822989907>;

type=application/smil
Start: <1822989907>
Type: application/smil

834 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 7 - FortiOS Carrier MMSConfiguration

Data (Post)
Multipart body

Part: 1, content-type: text/plain
Content-Type: text/plain; charset=iso-10646-ucs-2; name=Ciao.txt

Charset: iso-10646-ucs-2
Name: Ciao.txt

Headers
Content-Location: Ciao.txt

Line-based text data: text/plain
\377\376C\000i\000a\000o\000

[Unreassembled Packet: MMSE]

Sender notifications and logging

In most cases you will notify the sender that they are causing problems on the network— either by sending
malware content, flooding the network, or some other unwanted activity. The notification assumes the sender is
unaware of their activity and will stop or correct it when notified.

However, senders who are notified may use this information to circumvent administration’s precautions. For
example if flood notification is set to 1000 messages per minute, a notified user may simply reduce their
message to 990 messages per minute if this flood is intentional. For this reason, not all problems include sender
notifications.

There are two methods of notifying senders:

l MMS notifications
l Replacement messages

And three details to consider for logging and notifying administrators:

l Logging and reporting
l MMS logging options
l SNMP

MMS notifications

MMS notifications enable you to customize notifications for many different situations and differently for all the
supported MMSmessage protocols— MM1, MM3, MM4, and MM7.

MMS notification types include:

l Content Filter
l File Block
l Carrier Endpoint Block
l Flood
l Duplicate
l MMSContent Checksum
l Virus Scan

Day of Week,Window start time andWindow Duration define what days and what time of day alert
notifications will be sent. This allows you to control what alerts are sent on weekends. It also lets you control
when to start sending notifications each day. This can be useful if system maintenance is performed at the same
time each night — you might want to start alert notifications after maintenance has completed. Another reason to
limit the time alert messages are sent could be to limit message traffic to business hours.
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Notifications screen for FortiOS Carrier MMS Profile

For MMSNotification options, see MMSNotifications.

Replacement messages

FortiGate units send replacement messages when messages or content is blocked, quarantined, or otherwise
diverted from the receiver. In it’s place a message is sent to notify the receiver what happened.

With FortiOS Carrier MMS replacement messages, send and receive message types are supported separately
and receive their own custom replacement messages. This allows the network to potentially notify both the
sender and receiver of the problem.

For example the replacement messageMM1 send-req file block message is sent to the device that sent one
or more files that were banned. The default message that is sent is This device has sent %%NUM_
MSG%% messages containing banned files in the last %%DURATION%% hours. The two
variables are replaced by the appropriate values.

Replacement messages are not as detailed or specific as MMS notifications, but they are also not as complicated
to configure. They are also useful when content has been removed from an MMSmessage that was still
delivered.

Logging and reporting

With each virus infection, or file block, a syslog message is generated. The format of this syslog message is
similar to:

2005-09-22 19:15:47 deviceid=FGT5001ABCDEF1234 logid=0211060ABC type=virus
subtype=infected level=warning src=10.1.2.3 dst=10.2.3.4 srcintf=port1 dstintf=port2
service=mm1 status=blocked from="<sending MSISDN>" to="<receiving MSISDN>”
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file="eicar.com.txt" virus="EICAR_TEST_FILE" msg="The file eicar.com.txt is infected
with EICAR_TEST_FILE. ref
http://www.fortinet.com/VirusEncyclopedia/search/encyclopediaSearch.do?method=quickSea
rchDirectly&virusName=EICAR_TEST_FILE”

Note that the from and to fields are samples and not real values.

MMS logging options

You can enable logging in an MMS protection profile to write event log messages when the MMS protection
profile options that you have enabled perform an action. For example, if you enable MMS antivirus protection,
you could also use the MMS protection profile logging options to write an event log message every time a virus is
detected.

To record these log messages you must first configure how the FortiOS Carrier unit stores log messages.

To configure MMS content archiving, go to Security Profiles > MMS Profile. Select Create New or select the
Edit icon beside an existing profile. ExpandMMS Bulk AntiSpam Detection > Logging. Complete the fields
as described in the following table and select OK. For more a detailed list of options, see Logging.

SNMP

A simple SNMP trap will be generated to inform the operators’ alerting system that a virus has been detected.
This SNMP trap could contain the sending and receiving MSISDN, however the initial solution would reflect the
current behavior, i.e. only the fact that a virus has been detected will be communicated.

MMS content-based Antispam protection

ExpandMMS Scanning and select Content Filter in an MMS protection profile to create content filter
black/white lists that block or allow MMSmessages based on the content of the message.

Overview

A school computer lab may block age-inappropriate content. A place of business may block unproductive content.
A public access internet cafe may block offensive and graphic content. Each installation has its own requirements
for what content needs to be blocked, and in what language.

FortiOS Carrier provides the ability to create custom local dictionaries, black lists, and white lists in multiple
languages enables you to protect your customers from malicious content around the world.

Configurable dictionary

You can create a dictionary of configurable terms and phrases using the CLI. The text of MMSmessages will be
searched for these terms and phrases. Add content filter lists that contain content that you want to match in MMS
messages. For every match found, a score is added. If enough matches are found to set the total score above the
configured threshold, the MMSmessage is blocked.

You can add words, phrases, wild cards and Perl regular expressions to create content patterns that match
content in MMSmessages. For more on wildcard and regular expressions, see Using wildcards and Perl regular
expressions in the UTM guide.

For each pattern you can select Block or Exempt.

l Block adds an antispam black list pattern. Amatch with a block pattern blocks a message depending on the score of
the pattern and the content filter threshold.
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l Exempt adds an antispam white list pattern. Amatch with an exempt pattern allows the message to proceed
through the FortiOS Carrier unit, even if other content patterns in the same content filter list would block it.

If a pattern contains a single word, the FortiOS Carrier unit searches for the word in MMSmessages. If the
pattern contains a phrase, the FortiOS Carrier unit searches for all of the words in the phrase. If the pattern
contains a phrase in quotation marks, the FortiOS Carrier unit searches for the whole phrase.

You can create patterns with Simplified Chinese, Traditional Chinese, Cyrillic, French, Japanese, Korean,
Spanish, Thai, or Western character sets.

Black listing

Black listing is the practice of banning entries on the list. For example if an IP address continuously sends viruses,
it may be added to the black list. That means any computers that consult that list will not communicate with that
IP address.

Sometimes computers or devices can be added to black lists for a temporary problem, such as a virus that is
removed when notified. However, as a rule short of contacting the administrator in person to manually be
removed form the black list, users have to wait and they generally will be removed after a period without problem.

White listing

White listing is the practice of adding all critical IP addresses to a list, such as company email and web servers.
Then if those servers become infected and start sending spam or viruses, those servers are not blocked. This
allows the critical traffic through, even if there might be some malicious traffic as well. Blocking all traffic from
your company servers would halt company productivity.

Scores and thresholds

Each content pattern includes a score. When a MMSmessage is matched with a pattern the score is recorded. If
a message matches more than one pattern or matches the same pattern more than once, the score for the
message increases. When the total score for a message equals or exceeds the threshold the message is blocked.

The default score for a content filter list entry is 10 and the default threshold is 10. This means that by default a
message is blocked by a single match. You can change the scores and threshold so that messages can only be
blocked if there are multiple matches. For example, you may only want to block messages that contain the
phrase “example” if it appears twice. To do this, add the “example” pattern, set action to block and score to 5.
Keep the threshold at 10. If “example” is found twice or more in a message the score adds up 10 (or more) and
the message is blocked.

Configuring content-based antispam protection

To apply content-based antispam protection - CLI

config webfilter content
edit <filter_table_number>

set name <filter_table_name>
config entries

edit <phrase or regexp you want to block>
set action {block | exempt}
set lang <phrase language>
set pattern-type {wildcard | regexp}
set score <phrase score>
set status {enable | disable}

end
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end

Configuring sender notifications

When someone on the MMS network sends an MMSmessage that is blocked, in most cases you will notify the
sender. Typically an administrator is notified in addition to the sender so action can be taken if required. There
are two types of sender notifications available in FortiOS Carrier: MMS notifications, and Replacement
Messages.

MMS notifications

MMS notifications to senders are configured in Security Profiles > MMS Profile, under MMSNotifications.

In this section you can configure up to four different notification recipients for any combination of MM1/3/4/7
protocol MMSmessages. Also for MM7 messages the message type can be submit.REQ or deliver.REQ.

Useful settings include:

l delay in message based on notification type
l limit on notifications per second to prevent a flood
l schedules for notifications
l log in details for MM7 messages.

For more information on MMS notifications, see Notifying message flood senders and receivers and MMS
Notifications.

Replacement messages

Replacement messages are features common to both FortiOS and FortiOS Carrier, however FortiOS Carrier has
additional messages for the MMS traffic.

While each MMS protocol has its own different rec placement messages, the one common to all MMS protocols
is theMMS blocked content replacement message. This is the message that the receiver of the message
sees when their content is blocked.

MMS DLP archiving

You can use DLP archiving to collect and view historical logs that have been archived to a FortiAnalyzer unit or the
FortiGuard Analysis and Management service. DLP archiving is available for FortiAnalyzer when you add a
FortiAnalyzer unit to the FortiOS Carrier configuration. The FortiGuard Analysis and Management server
becomes available when you subscribe to the FortiGuard Analysis and Management Service.

You can configure full DLP archiving and summary DLP archiving. Full DLP archiving includes all content, for
example, full email DLP archiving includes complete email messages and attachments. Summary DLP archiving
includes just the meta data about the content, for example, email message summary records include only the
email header.

You can archive MM1, MM3, MM4, and MM7 content.

Configuring MMS DLP archiving

Select DLP archive options to archive MM1, MM3, MM4, and MM7 sessions. For each protocol you can archive
just session metadata (Summary), or metadata and a copy of the associated file or message (Full).

In addition to MMS protection profile DLP archive options you can:
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l Archive MM1 and MM7 message floods
l Archive MM1 and MM7 duplicate messages
l Select DLP archiving for carrier endpoint patterns in a Carrier Endpoint List and select the Carrier Endpoint
Block option in theMMS Scanning section of an MMSProtection Profile

FortiOS Carrier only allows one sixteenth of its memory for transferring content archive files. For example, for
Carrier-enabled FortiGate units with 128 MBRAM, only 8 MB of memory is used when transferring content
archive files. Best practices dictate to not enable full content archiving if antivirus scanning is also configured
because of these memory constraints.

To configure MMS DLP archiving - web-based manager

1. Go to Security Profiles > MMS Profile.
2. Select Create New or select the Edit icon beside an existing profile.
3. ExpandMMS Bulk AntiSpam Detection > Content Archive.
4. Complete the fields as described in DLP Archive options.
5. Select OK.

Viewing DLP archives

You can view DLP archives from the Carrier-enabled FortiGate unit web-based manager. Archives are historical
logs that are stored on a log device that supports archiving, such as a FortiAnalyzer unit.

These logs are accessed from either Log & Report > DLP Archive or if you subscribed to the FortiCloud
service, you can view log archives from there.

The DLP Archivemenu is only visible if one of the following is true.

l You have configured the FortiGate unit for remote logging and archiving to a FortiAnalyzer unit.
l You have subscribed to FortiCloud.

The following tabs are available when you are viewing DLP archives for one of these protocols.

l E-mail to view POP3, IMAP, SMTP, POP3S, IMAPS, SMTPS, and spam email archives.
l Web to view HTTP and HTTPS archives.
l FTP to view FTP archives.
l IM to view AIM, ICQ, MSN, and Yahoo! archives.
l MMS to view MMS archives.
l VoIP to view session control (SIP, SIMPLE and SCCP) archives.

If you need to view log archives in Raw format, select Raw beside the Column Settings icon.

GTP basic concepts

GPRS currently supports data rates from 9.6 kbps to more than 100 kbps, and is best suited for burst forms of
traffic. GPRS involves both radio and wired components. The mobile phone sends the message to a base station
unit (radio based), and the base station unit sends the message to the carrier network and eventually the Internet
(wired carrier network).

The network system then either sends the message back to a base station and to the destination mobile unit, or
forwards the message to the proper carrier’s network where it gets routed to the mobile unit.
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PDP Context
The packet data protocol (PDP) context is a connection between a mobile station and the end address that goes
through the SGSN and GGSN. It includes identifying information about the mobile customer used by each server
or device to properly forward the call data to the next hop in the carrier network, typically using a GTP tunnel
between the SGSN and GGSN.

When a mobile customer has an active voice or data connection open, both the SGSN and GGSN have the PDP
context information for that customer and session.

When a mobile phone attempts to communicate with an address on an external packet network, either an IP or
X.25 address, the mobile station that phone is connected to opens a PDP context through the SGSN and GGSN
to the end address. Before any traffic is sent, the PDP context must first be activated.

The information included in the PDP context includes the customer’s IP address, the IMSI number of the mobile
handset, and the tunnel endpoint ID for both the SGSN and GGSN. The ID is a unique number, much like a
session ID on a TCP/IP firewall. All this information ensures a uniquely identifiable connection is made.

Since one mobile device may have multiple connections open at one time, such as data connections to different
Internet services and voice connections to different locations, there may be more than one PDP context with the
same IP address making the extra identifying information required.

The endpoint that the mobile phone is connecting to only knows about the GGSN— the rest of the GPRS
connection is masked by the GGSN.

Along the PDP context path, communication is accomplished in using three different protocols.

l The connection between the Mobile Station and SGSN uses the SM protocol.
l Between SGSN and GGSN GTP is used.
l Between GGSN and the endpoint either IP or X.25 is used.

FortiOS Carrier is concerned with the SGSN to GGSN part of the PDP context — the part that uses GTP.

For more about PDP context, see Tunnel Management Messages.

Creating a PDP context

While FortiOS Carrier is concerned mostly with the SGSN to GGSN part of the PDPContext, knowing the steps
involved in creating a PDP context helps understand the role each device, protocol, and message type plays.

Both mobile stations and GGSNs can create PDP contexts.

A Mobile Station creates a PDP context

1. The Mobile Station (MS) sends a PDP activation request message to the SGSN including the MS PDP
address, and APN.

2. Optionally, security functions may be performed to authenticate the MS.
3. The SGSN determines the GGSN address by using the APN identifier.
4. The SGSN creates a down link GTP tunnel to send IP packets between the GGSN and SGSN.
5. The GGSN creates an entry in its PDP context table to deliver IP packets between the SGSN and the external

packet switching network.
6. The GGSN creates an uplink GTP tunnel to route IP-PDU from SGSN to GGSN.
7. The GGSN then sends back to the SGSN the result of the PDP context creation and if necessary the MS PDP

address.
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8. The SGSN sends an Activate PDP context accept message to the MS by returning negotiated the PDP
context information and if necessary the MS PDP address.

9. Now traffic can pass from the MS to the external network endpoint.

A GGSN creates a PDP context

1. The network receives an IP packet from an external network.
2. The GGSN checks if the PDPContext has already been created.
3. If not, the GGSN sends a PDU notification request to the SGSN in order to initiate a PDP context

activation.
4. The GGSN retrieves the IP address of the appropriate SGSN address by interrogating the HLR from the IMSI

identifier of the MS.
5. The SGSN sends to the MS a request to activate the indicated PDP context.
6. The PDP context activation procedure follows the one initiated by the MS. See “AMobile Station creates a PDP

context”.
7. When the PDP context is activated, the IP packet can be sent from the GGSN to the MS.

Terminating a PDP context

A PDP context remains open until it is terminated. To terminate the PDP context an MS sends a Deactivate
PDP context message to the SGSN, which then sends a Delete PDP Context message to the GGSN.
When the SGSN receives a PDP context deletion acknowledgment from the GGSN, the SGSN confirms to the
MS the PDP context deactivation. The PDP can be terminated by the SGSN or GGSN as well with a slight
variation of the order of the messages passed.

When the PDPContext is terminated, the tunnel it was using is deleted as well. If this is not completed in a timely
manner, it is possible for someone else to start using the tunnel before it is deleted. This hijacking will result in
the original customer being over billed for the extra usage. Anti-overbilling helps prevent this. See Configuring
Anti-overbilling in FortiOS Carrier.

GPRS security
The GPRS network has some built-in security in the form of GPRS authentication. However this is minimal, and is
not sufficient for carrier network security needs. A GTP firewall, such as FortiOS Carrier, is required to secure the
Gi, Gn, and Gp interfaces.

GPRS authentication

GPRS authentication is handled by the SGSN to prevent unauthorized GPRS calls from reaching the GSM
network beyond the SGSN (the base station system, and mobile station). Authentication is accomplished using
some of the customer’s information with a random number and uses two algorithms to create ciphers that then
allow authentication for that customer.

User identity confidentiality ensures that customer information stays between the mobile station and the SGSN
— no identifying information goes past the SGSN. Past that point other numbers are used to identify the
customer and their connection on the network.

Periodically the SGSNmay request identity information from the mobile station to compare to what is on record,
using the IMEI number.
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Call confidentiality is achieved through the use of a cipher, similar to the GPRS authentication described earlier.
The cipher is applied between the mobile station and the SGSN. Essentially a cipher mask is XORd with each
outgoing frame, and the receiving side XORs with its own cipher to result in the original frame and data.

Parts of a GTPv1 network
A sample GTP network consists of the end handset sender, the sender’s mobile station, the carrier’s network
including the SGSN and GGSN, the receiver's mobile station, and the receiver handset.

When a handset moves from one mobile station and SGSN to another, the handset’s connection to the Internet is
preserved because the tunnel the handset has to the Internet using GTP tracks the user’s location and
information. For example, the handset could move from one cell to another, or between countries.

The parts of a GPRS network can be separated into the following groups according to the roles of the devices:

l Radio access to the GPRS network is accomplished by mobile phones and mobile stations (MS).
l Transport the GPRS packets across the GPRS network is accomplished by SGSNs and GGSNs, both local and

remote, by delivering packets to the external services.
l Billing and records are handled by CDF, CFR, HLR, and VLR devices.

GPRS networks also rely on access points and PDP contexts as central parts of the communication structure.
These are not actual devices, but they are still critical .

These devices, their roles, neighboring devices, the interfaces and protocols they use are outlined in the following
table.

Carrier network showing the interfaces used (GTPv1)

Devices on a GTPv1 network

Device role Neighboring Devices Interfaces used Protocols used

Mobile Users Mobile Stations (MS) Radio Access
Technology (RAT)
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Device role Neighboring Devices Interfaces used Protocols used

Mobile Stations
(MS) Mobile Users, SGSN Gb IP, Frame Relay

SGSN (local) MS, SGSN (local or remote),
GGSN (local and remote),
CDR, CFR, HLR, VLR

Ga, Gb, Gn, Gp, Gz IP, Frame Relay, GTP,
GTP’

SGSN (remote) SGSN (local) Gn GTP

GGSN (local) SGSN (local or remote),
GGSN (local and remote),
CDR, CFR, HLR, VLR

Ga, Gi, Gn, Gp, Gz IP, GTP, GTP’

GGSN (remote)
SGSN (local), WAP gateway,
Internet, other external
services

Gi, Gp IP, GTPv1

CDR, CFR SGSN (local), GGSN (local) Ga, Gz GTP’

HLR, VLR SGSN (local), GGSN (local) Ga, Gz GTP’

Radio access
For a mobile phone to access the GPRS core network, it must first connect to a mobile station. This is a cellular
tower that is connected to the carrier network.

How the mobile phone connects to the mobile station (MS) is determined by what Radio Access Technologies
(RATs) are supported by the MS.

Transport
Transport protocols move data along the carrier network between radio access and the Internet or other carrier
networks.

FortiOS Carrier should be present where information enters the Carrier network, to ensure the information
entering is correct and not malicious. This means a Carrier-enabled FortiGate unit intercepts the data coming
from the SGSN or foreign networks destined for the SSGN or GGSN onto the network, and after the GGSN as the
data is leaving the network.

GTP

GPRS Tunnelling Protocol (GTP) is a group of IP-based communications protocols used to carry General Packet
Radio Service (GPRS) within Global System for Mobile Communications (GSM) and Universal Mobile
Telecommunications System (UMTS) networks. It allows carriers to transport actual cellular packets over a
network via tunneling. This tunneling allows users to move between SGSNs and still maintain connection to the
Internet through the GGSN.
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GTP has three versions version 0, 1, and 2. GTP1 and GTP2 are supported by FortiOS Carrier. The only GTP
commands that are common to all forms of GTP are the echo request/response commands that allow GSNs to
verify up to once every 60 seconds that neighboring GSNs are alive.

GTPv0

There have been three versions of GTP to date. The original version of GTP (version 0) has the following
differences from version GTPv1.

l the tunnel identification is not random
l there are options for transporting X.25
l the fixed port number 3386 is used for all functions, not just charging
l optionally TCP is allowed as a transport instead of UDP
l not all message types are supported in version 0

GTPv1

On a GPRS network, Packet Data Protocol (PDP) context is a data structure used by both the Serving GPRS
Support Node (SGSN) and the Gateway GPRSSupport Node (GGSN). The PDP context contains the subscribers
information including their access point, IP address, IMSI number, and their tunnel endpoint ID for each of the
SGSN and GGSN.

The Serving GPRS Support Node (SGSN) is responsible for the delivery of data packets from and to the mobile
stations within its geographical service area. Its tasks include packet routing and transfer, mobility management
(attach/detach and location management), logical link management, and authentication and charging functions.
The location register of the SGSN stores location information (e.g., current cell, current VLR) and user profiles
(e.g., IMSI, address(es) used in the packet data network) of all GPRS users registered with this SGSN.

GTPv1-C

GTPv1-C refers to the control layer of the GPRS Transmission network. This part of the protocol deals with
network related traffic.

FortiOS Carrier handles GTPv1-C in GTPv1 by using the Tunnel Endpoint IDentifier (TEID), IP address and a
Network layer Service Access Point Identifier (NSAPI), sometimes called the application identifier, as an integer
value that is part of the PDP context header information used to identify a unique PDP context in a mobile station,
and SGSN.

For more information on GTPv1-C, see GTP-C messages.

GTPv1-U

GTPv1-U is defined in 3GPP TS 29.281 and refers to the user layer of the GPRS Tunneling network. This part of
the protocol deals with user related traffic, user tunnels, and user administration issues.

A GTPv1-U tunnel is identified by a TEID, an IP address, and a UDP port number. This information uniquely
identifies the limb of a GTPv1 PDP context. The IP address and the UDP port number define a UDP/IP path, a
connectionless path between two endpoints (i.e. SGSN or GGSN). The TEID identifies the tunnel endpoint in the
receiving GTPv1-U protocol entity; it allows for the multiplexing and demultiplexing of GTP tunnels on a UDP/IP
path between a given GSN-GSN pair. For more information on GTPv1-U, see GTP-U messages.

The GTP core network consists of one or more SGSNs and GGSNs.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

845



GTP basic concepts Chapter 7 - FortiOS Carrier

GGSN

The Gateway GPRSSupport Node (GGSN) connects the GPRS network on one side via the SGSN to outside
networks such as the Internet. These outside networks are called packet data networks (PDNs). The GGSN acts
as an edge router between the two different networks— the GGSN forwards incoming packets from the external
PDN to the addressed SGSN and the GGSN also forwards outgoing packets to the external PDN. the GGSN also
converts the packets from the GPRS packets with SGSN to the external packets, such as IP or X.25.

SGSN

The Serving GPRS Support Node (SGSN) connects the GPRS network to GTPv1 compatible mobile stations, and
mobile units (such as UTRAN and ETRAN) on one side and to the gateway node (GGSN), which leads to external
networks, on the other side. Each SGSN has a geographical area, and mobile phones in that area connect to the
GPRS network through this SGSN. The SGSN also maintains a location register that contains customer’s location
and user profiles until they connect through a different SGSN at which time the customer information is moved to
the new SGSN. This information is used for packet routing and transfer, mobility management also known as
location management, logical link management, and authentication and billing functions.

GTPv2

GTPv2, defined in 3GPP TS 29.274, is dramatically different from GTPv1, defined in 3GPP TS 29.060. Where in
GTPv1 the tunnel is between the SGSN and the GGSN, in GTPv2 The SGSN is between the MME and the LTE
Serving Gateway (S-GW), beyond which is the PDN gateway (P-GW). Even tunnel management messages have
changed significantly.

Network diagram for GTPv2

Device roles on a GTPv2 network

Device role Neighboring Devices Interfaces used Protocols used

Mobile Users Mobile Stations (MS) Radio Access
Technology (RAT)

--

GTPv1 Mobile
Stations (MS) Mobile Users, SGSN Gb IP, Frame Relay
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Device role Neighboring Devices Interfaces used Protocols used

GTPv2 Mobile
Stations (MS)

Mobile Users, MME ??? IP, Frame Relay

SGSN (local) GTPv1 MS, SGSN, S-GW ??? IP, Frame Relay,
GTPv1, GTP’

S-GW SGSN, MME, P-GW ??? IP, GTPv2, GTP’

P-GW S-GW, Internet, other external
services ??? IP, GTPv2

GTPv2-C

GTPv2-C is the control layer messaging for GTPv2. It is used by LTEmobile stations, SGSN units for backwards
compatibility, and SGWs that are the gateway to other networks. The messaging is very different from GTPv1.
GTPv2-C is required to communicate with the Mobility Management Entity (MME) to create, change and delete
EPS bearers when handover events happen, and to create Forwarding tunnels. The protocol is also used to
communicate with the Serving Gateway (SGW) which has the S-GW and PDN-GW interfaces, and the Serving
GPRS Support Node (SGSN).

MME

MME essentially fills the role of the SGSN in a GTPv1 network— it is how the mobile stations gain access to the
Carrier network. GTPv2 supports different mobile stations than GTPv1, so MME handles the GTPv2 MSes and
SGSN handles the GTPv1 MSes

Billing and records
Amajor part of the GPRS network is devoted to billing. Customer billing requires enough information to identify
the customer, and then billing specific information such as connection locations and times, as well as amount of
data transferred. Amodified form of GTP called GTP’ is used for billing. The home location records and visitor
location records store information about customers that is critical to billing.

GTP’ (GTP prime)

GTP is used to handle tunnels of user traffic between SGSNs and GGSNs. However for billing purposes, other
devices that are not supported by GTP are required. GTP’ (GTP prime) is a modified form of GTP and is used to
communicate with these devices such as the Charging Data Function (CDF) that communicates billing
information to the Charging Gateway Function (CGF). In most cases, GTP‘ transports user records from many
individual network elements, such as the GGSNs, to a centralism computer which then delivers the charging data
more conveniently to the network operator's billing center, often through the CGF. The core network sends
charging information to the CGF, typically including PDP context activation times and the quantity of data which
the end user has transferred.

GTP’ is used by the Ga and Gz interfaces to transfer billing information. GTP’ uses registered UDP/TCP port
3386. GTP’ defines a different header, additional messages, field values, as well as a synchronization protocol to
avoid losing or duplicating CDRs on CGF or SGSN/GGSN failure. Transferred CDRs are encoded in ASN.1.
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HLR

The Home Location Register (HLR) is a central database that contains details of each mobile phone subscriber
that is authorized to use the GSM core network. There can be several logical, and physical, HLRs per public land
mobile network (PLMN), though one international mobile subscriber identity (IMSI)/MSISDN pair can be
associated with only one logical HLR (which can span several physical nodes) at a time. The HLRs store details of
every SIM card issued by the mobile phone operator. Each SIM has a unique identifier called an IMSI which is the
primary key to each HLR record.

VLR

The Visitor Location Register (VLR) is a database which stores information about all the mobile devices that are
currently under the jurisdiction of the Mobile Switching Center which it serves. Of all the information the VLR
stores about each Mobile Station, the most important is the current Location Area Identity (LAI). This information
is vital in the call setup process.

Whenever an MSC detects a new MS in its network, in addition to creating a new record in the VLR, it also
updates the HLR of the mobile subscriber, informing it of the new location of that MS.

For more information on GTP‘, see GTP-U and Charging Management Messages.

GPRS network common interfaces
There are interfaces for each connection on the GPRS network. An interface is an established standard form of
communication between two devices. Consider a TCP/IP network. In addition to the transport protocol (TCP)
there are other protocols on that network that describe how devices can expect communications to be organized,
just like GPRS interfaces.

Interfaces between devices on the network

There are a series of interfaces that define how different devices on the carrier network communicate with each
other. There interfaces are called Ga to Gz, and each one defines how a specific pair of devices will
communicate. For example Gb is the interface between the base station and the SGSN, and Gn is one possible
interface between the SGSN and GGSN.

The SGSN and GGSN keep track of the CDR information and forward it to the Charging Data Function (CDF)
using the Gr interface between the SGSN and home location register (HLR), Gs interface between the SGSN and
MSC (VLR), Gx interface between the GGSN and the Charging Rules Function (CRF), Gy between the GGSN
and online charging system (OCS), and finally Gz which is the off-line (CDR-based) charging interface between
the GSN and the CG that uses GTP'.

Each of these interfaces on the GPRS network is has a name in the format of Gx where x is a letter of the
alphabet that determines what part of the network the interface is used in. It is common for network diagrams of
GPRS networks to include the interface name on connections between devices.

The Carrier-enabled FortiGate unit only provides protection on the Gn, Gp, and Gi
interfaces.
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GPRS network interfaces, their roles, and billing

Name Device connections that use
this interface

Traffic Protocol
used Its role or how it affects billing

Ga CDR and GSN (SGSNs and
GGSNs)

GTP‘ - GTP
modified to include
CDR role

CDR have the accounting records, that
are compiled in the GSN and then sent to
the Charging Gateway (CG)

Gb MS and SGSN Frame Relay or IP
When an IP address moves to a new MS,
the old MSmay continue to use and bill
that IP address.

Gi GGSN and public data
networks (PDNs)

IP based This is the connection to the Internet. If
the GTP tunnel is deleted without
notifying the Gi interface, the connection
may remain open incurring additional
charges. FortiOS Carrier adds this
interface to a firewall. See Anti-overbilling
with FortiOS Carrier.

Gn SGSN and external SGSNs
and internal GGSNs GTP When the GTP tunnel is deleted, need to

inform other interfaces immediately to
prevent misuse of connections remaining
open. FortiOS Carrier adds this interface
to a firewall.

Gp Internal SGSN and external
GGSNs

GTP

Gz GSN (SGSN and GGSN) and
the charging gateway (CG) GTP‘ Used for the offline charging interface.

Ga is used for online charging.

Corporate customers may have a direct connection to the Gi interface for higher security. The Gi interface is
normally an IP network, though a tunnelling protocol such as GRE or IPsec may be used instead.

GTP Configuration

The GTP (GPRS Tunneling Protocol) is one of the major mobile core protocols used since to transfer data in the
core mobile network. Mobility and data are exploding and this trend will continue with VoLTE, 5G, and the
Internet of Things (IoT). The role of GTP in mobile networks will continue to remain critical.

With the mobile network ever growing importance as the communication channel for data rich application on
mobile devices, connected intelligent devices and the IoT, comes the growing potential for attacks on the mobile
infrastructure.

Introduction to GTP

GTP as a Potential Attack Vector

GTP’s role in transferring data in the core mobile infrastructure makes it a potential ideal attack vector. To
understand the security features for GTPwe need to understand the risks that might compromise this protocol.
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The business impact might varies in-between the different attacks from Denial of Service (DoS) attacks that
hinders the capability of performing a legitimate operation due to resource starvation (for example - not being
able to charge the customer for GPRS traffic use due to denial of service attack on the Charging GW) to remote
compromise attacks that allows the hacker to have remote control of a critical device (for example – take control
over a GGSN).

GTP-based attacks may have a wide range of business impact, based on the attacked devices’ vulnerability,
ranging from service unavailability, compromise customer information, and gaining control over infrastructure
elements, just to give a few examples.

Listed below are the main categories of GTP-based attacks:

l Protocol anomaly attacks are packets and packets formats that should not be expected on the GTP protocol.
These can include malformed packets, reserved packets’ fields and types, etc.

l Infrastructure attacks are attempts to connect to restricted core elements, such as the GGSN, SGSN, PGW, etc.
l Overbilling attacks results in customers charged for traffic they did not use or the opposite of not paying for the

used traffic.

Protecting Against GTP-Based Attacks: The Carrier Grade GTP Firewall

With the evolution of the mobile network so has GTP evolved. The awareness to the potential of GTP-based
attacks has led mobile core vendors to harden their software to better deal with a potential attack. Alongside this
evolution, network security vendors, such as Fortinet, has led the way in providing specific GTP aware firewalls to
secure and protect the different versions of the GTP protocol from potential attacks.

A GTP firewall should be placed where GTP traffic and session originate and terminate, as shown in the below
diagram, and has to inspect both the GTP-C (Control Plane) and GTP-U (Data Plane) packets that, together,
constitute the GPRS Tunneling Protocol.

The GTP firewall in both cases is placed in line between the SGSN / SGW and the GGSN / PGW which are the
initiator and terminator of the GTP traffic. One of the main roles of GTP firewall is also to be able to support the
roaming between different versions of GTPwithout interrupting the service.

The GTP firewall must be carrier grade in its ability to scale and provide high availability without impact its ability
to provide effective protection.

FortiGate with FortiCarrier – The Leading GTP Firewall

FortiGate is Fortinet’s physical security platform, built specifically for high performance and scalability with the
utilization of specialized FortiASIC technology. Fortinet Content Processors (CP) and Network Processors (NP)
enable, offloading CPU intensive tasks and allowing the FortiGate to provide carrier grade performance and
scalability. Utilizing the power of the FortiGate platform, FortiOS, Fortinet’s security Operating System, provides
threat intelligence and advanced functionalities to provide effective security, ranging from Carrier Grade NAT
(CGNAT), firewalling, IPSec, etc.

FortiCarrier is the part of FortiOS which was specifically designed to provide security for specific carriers and
mobile operators’ protocols and requirements, such as awareness and security for GTP. The wide range of
FortiGate platforms with FortiOS and FortiCarrier enables mobile operators to cost effectively secure their mobile
network against GTP-based attacks, while ensuring unparalleled performance, availability and security
effectiveness.
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GTP Profile
You can configure multiple GTP profiles within the GTPmenu. GTP profiles concern GTP activity flowing through
the unit. These GTP profiles are then applied to a security policy.

GTP profile configuration settings

The following are GTP profile configuration settings in Security Profiles > GTP Profiles.

GTP Profile

Lists each GTP profile that you have created. On this page, you can edit, delete or create a new GTP profile.

Create New Creates a new GTP profile. When you select Create New, you are
automatically redirected to the New page.

Edit Modifies settings within a GTP profile in the list. When you select Edit, you
are automatically redirected to Edit page.

Delete

Removes a GTP profile from the list.

To remove multiple GTP profiles from within the list, on the GTP Profile
page, in each of the rows of the profiles you want removed, select the
check box and then select Delete.

To remove all GTP profiles from within the list, on the GTP Profile page,
select the check box in the check box column and then select Delete.

Name The name of the GTP profile.
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Ref.

Displays the number of times the object is referenced to other objects. For
example, av_1 profile is applied to a security policy; on the Profile page
(Security Profiles > Antivirus > Profiles), 1 appears in Ref. .

To view the location of the referenced object, select the number in Ref.,
and the Object Usage window appears displaying the various locations of
the referenced object.

To view more information about how the object is being used, use one of
the following icons that is available within the Object Usage window:

•  View the list page for these objects – automatically redirects you to
the list page where the object is referenced at.

•  Edit this object – modifies settings within that particular setting that the
object is referenced with. For example, av_1 profile is referenced with a
security policy and so, when this icon is selected, the user is redirected to
the Edit Policy page.

•  View the details for this object – table, similar to the log viewer table,
contains information about what settings are configured within that
particular setting that the object is referenced with. For example, av_1
profile is referenced with a security policy, and that security policy’s settings
appear within the table.

New GTP Profile

Provides settings for configuring a GTP profile.

Name Enter a name for the GTP profile.

General Settings Configure general options for the GTP profile.

Message Type Filtering Configure filtering for messages.

APN Filtering Configure filtering options for APN.

Basic Filtering Configure filtering options for IMSI.

Advanced Filtering Configure advanced filtering options.

IE removal policy Configure IE removal policy options.

Encapsulated IP Traffic
Filtering

Configure filtering options for encapsulated IP traffic.

Encapsulated Non-IP End
User Address Filtering Configure filtering options for encapsulated non-IP end user addresses.
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Protocol Anomaly Configure protocol anomaly options.

Anti-Overbilling Configure anti-overbilling options.

Log Configure log options.

General settings options

The following are mostly house keeping options that appear in the General Settings area of the GTP
configuration page.

General Settings section of the New GTP Profile

GTP-in-GTP Select Allow to enable GTP packets to be allowed to contain GTP
packets, or a GTP tunnel inside another GTP tunnel.

To block all GTP-in-GTP packets, select Deny.

Minimum Message Length

Enter the shortest possible message length in bytes. Normally this is
controlled by the protocol, and will vary for different message types. If a
packet is smaller than this limit, it is discarded as it is likely malformed and
a potential security risk.

The default minimum message length is 0 bytes.

Maximum Message Length Enter the maximum allowed length of a GTP packet in bytes.

A GTP packet contains three headers and corresponding parts GTP, UDP,
and IP. If a packet is larger than the maximum transmission unit (MTU)
size, it is fragmented to be delivered in multiple packets. This is inefficient,
resource intensive, and may cause problems with some applications.

By default the maximum message length is 1452 bytes.

Tunnel Limit

Enter the maximum number of tunnels allowed open at one time. For
additional GTP tunnels to be opened, existing tunnels must first be closed.

This feature can help prevent a form of denial of service attack on your
network. This attack involves opening more tunnels than the network can
handle and consuming all the network resources doing so. By limiting the
number of tunnels at any one time, this form of attack will be avoided.

The tunnel limiting applies to the Handover Group, and Authorized SGSNs
and GGSNs.
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General Settings section of the New GTP Profile

Tunnel Timeout Enter the maximum number of seconds that a GTP tunnel is allowed to
remain active. After the timeout the unit deletes GTP tunnels that have
stopped processing data. A GTP tunnel may hang for various reasons. For
example, during the GTP tunnel tear-down stage, the "delete pdap context
response" message may get lost. By setting a timeout value, you can
configure the FortiOS Carrier firewall to remove the hanging tunnels.

The default is 86400 seconds, or 24 hours.

Control plane message rate
limit

Enter the number of packets per second to limit the traffic rate to protect
the GSNs from possible Denial of Service (DoS) attacks. The default limit
of 0 does not limit the message rate.

GTPDoS attacks can include:

•  Border gateway bandwidth saturation: A malicious operator can
connect to your GRX and generate high traffic towards your Border
Gateway to consume all the bandwidth.

•  GTP flood: A GSN can be flooded by illegitimate traffic

Handover Group Select the allowed list of IP addresses allowed to take over a GTP session
when the mobile device moves locations.

Handover is a fundamental feature of GPRS/UMTS, which enables
subscribers to seamlessly move from one area of coverage to another with
no interruption of active sessions. Session hijacking can come from the
SGSN or the GGSN, where a fraudulent GSN can intercept another GSN
and redirect traffic to it. This can be exploited to hijack GTP tunnels or
cause a denial of service.

When the handover group is defined it acts like a white list with an implicit
default deny at the end — the GTP address must be in the group or the
GTPmessage will be blocked. This stops handover requests from
untrusted GSNs.

Authorized SGSNs

Use Authorized SGSNs to only allow authorized SGSNs to send packets
through the unit and to block unauthorized SGSNs. Go to Firewall
Objects > Address > Addresses and add the IP addresses of the
authorized SGSNs to a firewall address or address group. Then set
Authorized SGSNs to this firewall address or address group.

You can use Authorized SGSNs to allow packets from SGSNs that have
a roaming agreement with your organization.
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General Settings section of the New GTP Profile

Authorized GGSNs Use Authorized GGSNs to only allow authorized GGSNs to send packets
through the unit and to block unauthorized GGSNs. Go to Firewall
Objects > Address > Addresses and add the IP addresses of the
authorized GGSNs to a firewall address or address group. Then set
Authorized GGSNs to this firewall address or address group.

You can use Authorized GGSNs to allow packets from SGSNs that have a
roaming agreement with your organization.

Message type filtering options

On the New GTP Profile page, you can select to allow or deny the different types of GTPmessages, which is
referred to as message type filtering. You must expand the Message Type Filtering section to access the
settings.

The messages types include Path Management, Tunnel Management, Location Management, Mobility
Management, MBMS, and GTP-U and Charging Management messages.

For enhanced security, Fortinet best practices dictate that you set Unknown Message
Action to deny. This will block all unknown GTPmessage types, some of which may be
malicious.

To configure message type filter options, expandMessage Type Filtering in the GTP profile.

APN filtering options

An Access Point Name (APN) is an Information Element (IE) included in the header of a GTP packet. It provides
information on how to reach a network.

An APN has the following format:

<network_id>[.mnc<mnc_int>.mcc<mcc_int>.gprs]

Where:

l <network_id> is a network identifier or name that identifies the name of a network, for example, example.com
or internet.

l [.mnc<mnc_int>.mcc<mcc_int>.gprs] is the optional operator identifier that uniquely identifies the
operator’s PLMN, for example mnc123.mcc456.gprs.

Combining these two examples results in a complete APN of internet.mnc123.mcc456.gprs.

By default, the unit permits all APNs. However, you can configure APN filtering to restrict roaming subscribers'
access to external networks.

APN filtering applies only to the GTP create pdp requestmessages. The unit inspects GTP packets for both
APN and selected modes. If both parameters match and APN filter entry, the unit applies the filter to the traffic.

Additionally, the unit can filter GTP packets based on the combination of an IMSI prefix and an APN.

You cannot add an APN when creating a new profile.
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APN Filtering

Enable APN Filter Select to enable APN filtering.

Default APN Action Select the default action for APN filtering. If you select Allow, all sessions
are allowed except those blocked by individual APN filters. If you select
Deny, all sessions are blocked except those allowed by individual APN
filters.

Value The APN to be filtered.

Mode The type of mode chosen that indicates where the APN originated and
whether the Home Location Register (HLR) has verified the user
subscription:

Action The type of action that will be taken.

Edit Modifies the settings within the filter. When you select Edit, the Edit
window appears, which allows you to modify the settings of the APN.

Delete Removes the APN from the list within the table, in the APN Filtering
section.

Add APN Adds a new APN filter to the list. When you select Add APN, the New
window appears, which allows you to configure the APN settings.

New APN page

Value Enter an APN to be filtered. You can include wild cards to match multiple
APNs. For example, the value internet* would match all APNs that being
with internet.

Mode
Select one or more of the available modes to indicate where the APN
originated and whether the Home Location Register (HLR) has verified the
user subscription.

Mobile Station
provided

MS-provided APN, subscription not verified, indicates that the mobile
station (MS) provided the APN and that the HLR did not verify the user's
subscription to the network.

Network provided
Network-provided APN, subscription not verified, indicates that the
network provided a default APN because the MS did not specify one, and
that the HLR did not verify the user's subscription to the network.

Subscription Verified MS or Network-provided APN, subscription verified, indicates that the MS
or the network provided the APN and that the HLR verified the user's
subscription to the network

Action Select Allow orDeny.
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Basic filtering options

The International Mobile Station Identity (IMSI) is used by a GPRSSupport Node (GSN) to identify a mobile
station. Three elements make up every IMSI:

l the mobile country code (MCC)
l the mobile network code (MNC)
l the mobile subscriber identification number (MSIN).

The subscriber's home network—the public land mobile network (PLMN)—is identified by the IMSI prefix, formed
by combining the MCC and MNC.

By default, the unit allows all IMSIs. You can add IMSI prefixes to deny GTP traffic coming from non-roaming
partners. Any GTP packets with IMSI prefixes not matching the prefixes you set will be dropped. GTPCreate
pdp request messages are filtered and only IMSI prefixes matching the ones you set are permitted. Each GTP
profile can have up to 1000 IMSI prefixes set.

An IMSI prefix and an APN can be used together to filter GTP packets if you set an IMSI filter entry with a non-
empty APN.

You cannot add an IMSI when creating a new profile. You must add it after the profile has
been created and you are editing the profile.

IMSI Filtering section of the New GTP Profile

Enable IMSI Filter Select to enable IMSI filtering.

Default IMSI Action Select the default action for IMSI filtering. If you select Allow, all sessions
are allowed except those blocked by individual IMSI filters. If you select
Deny, all sessions are blocked except those allowed by individual IMSI
filters.

APN The APN that is part of the IMSI that will be filtered.

MCC-MNC The MCC-MNC part of the IMSI that will be filtered.

Mode The type of mode that indicates where the APN originated and whether
the Home Location Register (HLR) has verified the user subscription.

Action The type of action that will be taken.

Edit Modifies settings to an IMSI filter. When you select Edit, the Edit window
appears, which allows you to modify the IMSI filter’s settings.

Delete Removes an IMSI filter from within the table, in the IMSI Filtering section.

Add IMSI Adds a new IMSI filter to the list. When you select Add IMSI, the New
window appears, which allows you to configure IMSI filter settings.

New IMSI page
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APN Enter the APN part of the IMSI to be filtered.

MCC-MNC Enter the MCC-MCC part of the IMSI to be filtered.

Mode
Select one or more of the available modes to indicate where the APN
originated and whether the Home Location Register (HLR) has verified the
user subscription.

Mobile Station
provided

MS-provided APN, subscription not verified, indicates that the mobile
station (MS) provided the APN and that the HLR did not verify the user's
subscription to the network.

Network provided
Network-provided APN, subscription not verified, indicates that the
network provided a default APN because the MS did not specify one, and
that the HLR did not verify the user's subscription to the network.

Subscription Verified MS or Network-provided APN, subscription verified, indicates that the MS
or the network provided the APN and that the HLR verified the user's
subscription to the network

Action Select Allow orDeny.

Advanced filtering options

The FortiOS Carrier firewall supports advanced filtering against the attributes RAT, RAI, ULI, APN restriction, and
IMEI-SV in GTP to block specific harmful GPRS traffic and GPRS roaming traffic. The following table shows
some of the GTP context requests and responses that the firewall supports.

Attributes supported by FortiCarrier firewalls

GTP Create PDP
Context Request

GTP Create PDP Con-
text Response

GTP Update PDP Con-
text Request

GTP Update PDP
Context
Response

APN yes yes -

APN
Restriction yes - - yes

IMEI-SV yes - - -

IMSI yes - yes -

RAI yes - yes -

RAT yes - yes -

ULI yes - yes -
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When editing a GTP profile, select Advanced Filtering > Create New to create and add a rule. When the rule
matches traffic it will either allow or deny that traffic as selected in the rule.

Advanced Filtering

Enable Select to enable advanced filtering.

Default Action Select the default action for advanced filtering. If you select Allow, all
sessions are allowed except those blocked by individual advanced filters.
If you select Deny, all sessions are blocked except those allowed by
individual advanced filters.

Messages The messages, for example, Create PDPContext Request.

APN Restriction The APN restriction.

RAT Type The RAT types associated with that filter.

ULI The ULI pattern.

RAI The RAI pattern.

IMEI The IMEI pattern.

Action The action that will be taken.

Edit Modifies the filter’s settings. When you select Edit, the Edit window
appears, which allows you to modify the filter’s settings.

Delete Removes a filter from the list.

Add Adds a filter to the list. When you select Add, the New window appears,
which allows you to configure settings for messages, APN, IMSI,
MSISDN, RAT type, ULI, RAI, IMEI patterns as well as the type of
action.

New Filtering page

Messages The PDP content messages this profile will match.

Create PDP
Context Request Select to allow create PDP context requests.

Create PDP
Context Response

Select to allow create PDP context responses.

Update PDP
Context Request Select to allow update PDP context requests.
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Update PDP
Context Response

Select to allow update PDP context responses.

APN Enter the APN.

APN Mode Select an APNmode as one or more of

•  Mobile Station provided
•  Network provided
•  Subscription provided

This field is only available when an APN has been entered.

Mobile Station
provided

MS-provided PAN, subscription not verified, indicates that the mobile
station (MS) provided the APN and that the HLR did not verify the user’s
subscription to the network.

Network provided Network-provided APN, subscription not verified, indicates that the
network provided a default APN because the MS did not specify one,
and that the HLR did no verify the user’s subscription to the network.

Subscription verified
MS or Network-provided APN, subscription verified, indicates that the
MS or the network provided the APN and that the HLR verified the user’s
subscription to the network.

APN Restriction Select the type of restriction that you want. You can choose all of the
types, or one of the types. You cannot choose multiple types. Types
include:

•  all
•  Public-1
•  Public-2
•  Private-1
•  Private-2

IMSI Enter the IMSI.

MSISDN Enter the MSISDN.

RAT Type

Optionally select the RAT type as any combination of the following:

•  Any
•  UTRAN
•  GERAN
•  Wifi
•  GAN
•  HSPA

Some RAT types are GTPv1 specific.
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ULI pattern Enter the ULI pattern.

RAI pattern Enter the RAI pattern.

IMEI pattern Enter the IMEI pattern.

Action Select eitherAllow orDeny.

Adding an advanced filtering rule

When adding a rule, use the following formats:

l Prefix, for example, range 31* for MCCmatches MCC from 310 to 319.
l Range, for example, range 310-319 for MCCmatches MCC from 310 to 319.
l Mobile Country Code (MCC) consists of three digits. The MCC identifies the country of domicile of the mobile

subscriber.
l Mobile Network Code (MNC) consists of two or three digits for GSM/UMTS applications. The MNC identifies the

home PLMN of the mobile subscriber. The length of the MNC (two or three digits) depends on the value of the
MCC. Best practices dictate not to mix two and three digit MNC codes within a single MCC area.

l Location Area Code (LAC) is a fixed length code (of 2 octets) identifying a location area within a PLMN. This part of
the location area identification can be coded using a full hexadecimal representation except for the following
reserved hexadecimal values: 0000 and FFFE. These reserved values are used in some special cases when no
valid LAI exists in the MS (see 3GPP TS 24.008, 3GPP TS 31.102 and 3GPP TS 51.011).

l Routing Area Code (RAC) of a fixed length code (of 1 octet) identifies a routing area within a location.
l CI or SAC of a fixed length of 2 octets can be coded using a full hexadecimal expression.
l Type Allocation Code (TAC) has a length of 8 digits.
l Serial Number (SNR) is an individual serial number identifying each equipment within each TAC. SNR has a length

of 6 digits.
l Software Version Number (SVN) identifies the software version number of the mobile equipment. SVN has a length

of 2 digits.

You cannot add an advanced filtering rule when creating a new profile. You must add it
after the profile has been created and you are editing the profile.

Information Element (IE) removal policy options

In some roaming scenarios, the unit is installed on the border of the PLMN and the GRX. In this configuration, the
unit supports information element (IE) removal policies to remove any combination of R6 IEs (RAT, RAI, ULI,
IMEI-SV and APN restrictions) from the types of messages described in “Advanced filtering options”, prior to
forwarding the messages to the HGGSN (proxy mode).

IE removal policy

Enable Select to enable this option.
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SGSN address of message
IE

The firewall address or address group that contains the SGSN addresses.

IEs to be removed The IE types that will be removed. These include APN Restriction, RAT,
RAI, ULI, and IMEI.

Add Adds an IE removal policy. When you select Add, the New window
appears, which allows you to configure the IE policy.

Edit
Modifies settings from within the IE removal policy. When you select Edit,
the Edit window appears, which allows you to modify the settings within the
policy.

Delete Removes the IE removal policy from the list.

New IE policy page

SGSN address Select a firewall address or address group that contains SGSN addresses.

IEs to be removed Select one or more IE types to be removed. These include APN Restriction,
RAT, RAI, ULI, and IMEI.

Encapsulated IP traffic filtering options

You can use encapsulated IP traffic filtering to filter GTP sessions based on information contained in the data
stream. to control data flows within your infrastructure. You can configure IP filtering rules to filter encapsulated
IP traffic from mobile stations by identifying the source and destination policies. For more information, see When
to use encapsulated IP traffic filtering.

Expand Encapsulated IP Traffic Filtering in the GTP profile to reveal the options.

Encapsulated IP Traffic Filtering

Enable IP Filter Select to enable encapsulated IP traffic filtering options.

Default IP Action Select the default action for encapsulated IP traffic filtering. If you select
Allow, all sessions are allowed except those blocked by individual
encapsulated IP traffic filters. If you select Deny, all sessions are blocked
except those allowed by individual encapsulated IP traffic filters.

Source
Select a source IP address from the configured firewall IP address or
address group lists. Any encapsulated traffic originating from this IP
address will be a match if the destination also matches.

Destination Select a destination IP address from the configured firewall IP address or
address group lists. Any encapsulated traffic being sent to this IP address
will be a match if the destination also matches.
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Action

The type of action that will be taken.

Select to Allow orDeny encapsulated traffic between this source and
Destination.

Edit Modifies the source, destination or action settings.

Add IP Policy Adds a new encapsulated IP traffic filter. When you select Add IP Policy,
the New window appears which allows you to configure IP policy settings.

New (window)

Source Select the source firewall address or address group.

Destination Select the destination firewall address or address group.

Action Select Allow orDeny.

Encapsulated non-IP end user traffic filtering options

Depending on the installed environment, it may be beneficial to detect GTP packets that encapsulate non-IP
based protocols. You can configure the FortiOS Carrier firewall to permit a list of acceptable protocols, with all
other protocols denied.

The encoded protocol is determined in the PDP Type Organization and PDP Type Number fields within the End
User Address Information Element. The PDP Type Organization is a 4-bit field that determines if the protocol is
part of the ETSI or IETF organizations. Values are zero and one, respectively. The PDP Type field is one byte
long. Both GTP specifications list only PPP, with a PDP Type value of one, as a valid ETSI protocol. PDP Types
for the IETF values are determined in the “Assigned PPPDLL Protocol Numbers” sections of RFC1700. The PDP
types are compressed, meaning that the most significant byte is skipped, limiting the protocols listed from 0x00
to 0xFF.

Encapsulated Non-IP End User Address Filtering

Enable Non-IP Filter Select to enable encapsulated non-IP traffic filtering.

Default Non-IP Action Select the default action for encapsulated non-IP traffic filtering. If you
select Allow, all sessions are allowed except those blocked by individual
encapsulated non-IP traffic filters. If you select Deny, all sessions are
blocked except those allowed by individual encapsulated non-IP traffic
filters.

Type The type chosen, AESTI or IETF.

Start Protocol The beginning protocol port number range.

End Protocol The end of the protocol port number range.

Action The type of action that will be taken.
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Edit Modify a non-IP filter's settings in the list. When you select Edit, the Edit
window appears, which allows you to modify the Non-IP policy settings.

Delete Remove a non-IP policy from the list.

Add Non-IP Policy Add a new encapsulated non-IP traffic filter. When you select Add Non-IP
Policy, you are automatically redirected to the New page.

New (window)

Type Select AESTI or IETF.

Start Protocol

End Protocol

Select a start and end protocol from the list of protocols in RFC 1700.
Allowed range includes 0 to 255 (0x00 to 0xff). Some common protocols
include:

•  33 (0x0021)   Internet Protocol
•  35 (0x0023)   OSI Network Layer
•  63 (0x003f)    NETBIOS Framing
•  65 (0x0041)   Cisco Systems
•  79 (0x004f)    IP6 Header Compression
•  83 (0x0053)   Encryption

Action Select Allow orDeny.

Protocol Anomaly prevention options

Use protocol anomaly detection options to detect or deny protocol anomalies according to GTP standards and
tunnel state. Protocol anomaly attacks involve malformed or corrupt packets that typically fall outside of the
protocol specifications. Packets cannot pass through if they fail the sanity check.

Protocol Anomaly

Invalid Reserved Field

GTP version 0 (GSM 09.60) headers specify a number of fields that are
marked as ''Spare” and contain all ones (1). GTP packets that have
different values in these fields are flagged as anomalies. GTP version 1
(GSM 29.060) makes better use of the header space and only has one, 1-
bit, reserved field. In the first octet of the GTP version1 header, bit 4 is set
to zero.

Reserved IE Both versions of GTP allow up to 255 different Information Elements (IE).
However, a number of Information Elements values are undefined or
reserved. Packets with reserved or undefined values will be filtered.

Miss Mandatory IE GTP packets with missing mandatory Information Elements (IE) will not be
passed to the GGSN.
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Out of State Message The GTP protocol requires a certain level of state to be kept by both the
GGSN and SGSN. Some message types can only be sent when in a
specific GTP state. Packets that do not make sense in the current state are
filtered or rejected

Both versions of GTP allow up to 255 different message types. However, a
number of message type values are undefined or reserved.

Best practices dictate that packets with reserved or undefined values will be
filtered.

Out of State IE GTPPackets with out of order Information Elements are discarded.

Spoofed Source Address The End User Address Information Element in the PDPContext Create &
Response messages contain the address that the mobile station (MS) will
use on the remote network. If the MS does not have an address, the SGSN
will set the End User Address field to zero when sending the initial PDP
Context Create message. The PDPContext Response packet from the
GGSN will then contain an address to be assigned to the MS. In
environments where static addresses are allowed, the MSwill relay its
address to the SGSN, which will include the address in the PDPContext
Create Message. As the MS address is negotiated within the PDPContext
creation handshake, any packets originating from the MS that contain a
different source address are detected and dropped.

Anti-Overbilling options

You can configure the FortiOS Carrier firewall to prevent over billing subscribers for traffic over the. To enable
anti-overbilling, you must configure both the Gn/Gp firewall and the Gi firewall.

Expand Anti-Overbilling in the GTP profile to reveal these settings.

Anti-Overbilling

Gi Firewall IP Address The IP address of the unit’s interface configured as a Gi gateway.

Port The SG security port number. The default port number is port 21123.
Change this number if your system uses a different SG port.

Interface Select the unit interface configured as a Gi gateway.

Security Context ID Enter the security context ID. This ID must match the ID entered on the
server Gi firewall. The default security context ID is 696.

Log options

All the GTP logs are treated as a subtype of the event logs. To enable GTP logging, you must:

l configure the GTP log settings in a GTP profile
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Log

Log Frequency Enter the number of messages to drop between logged messages.

An overflow of log messages can sometimes occur when logging rate-
limited GTP packets exceed their defined threshold. To conserve resources
on the syslog server and the Carrier-enabled FortiGate unit, you can
specify that some log messages are dropped. For example, if you want
only every twentieth message to be logged, set a logging frequency of 20.
This way, 20 messages are skipped and the next logged.

Acceptable frequency values range from 0 to 2147483674. When set to ‘0’,
no messages are skipped.

Forwarded Log Select to log forwarded GTP packets.

Denied Log Select to log GTP packets denied or blocked by this GTP profile.

Rate Limited Log Select to log rate-limited GTP packets.

State Invalid Log Select to log GTP packets that have failed stateful inspection.

Tunnel Limit Log Select to log packets dropped because the maximum limit of GTP tunnels
for the destination GSN is reached.

Extension Log Select to log extended information about GTP packets. When enabled, this
additional information will be included in log entries:

•  IMSI
•  MSISDN
•  APN
•  Selection Mode
•  SGSN address for signaling
•  SGSN address for user data
•  GGSN address for signaling
•  GGSN address for user data

866 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 7 - FortiOS Carrier GTPConfiguration

Traffic count Log Select to log the total number of control and user data messages received
from and forwarded to the GGSNs and SGSNs that the unit protects.

The unit can report the total number of user data and control messages
received from and forwarded to the GGSNs and SGSNs it protects.
Alternately, the total size of the user data and control messages can be
reported in bytes. The unit differentiates between traffic carried by each
GTP tunnel, and also between GTP-User and GTP-Control messages.

The number of messages or the number of bytes of data received from and
forwarded to the SGSN or GGSN are totaled and logged if a tunnel is
deleted.

When a tunnel is deleted, the log entry contains:

•  Timestamp
•  Interface name (if applicable)
•  SGSN IP address
•  GGSN IP address
•  TID
•  Tunnel duration time in seconds
•  Number of messages sent to the SGSN
•  Number of messages sent to the GGSN

Specifying logging types

You can configure the unit to log GTP packets based on their status with GTP traffic logging.

The status of a GTP packet can be any of the following 5 states:

l Forwarded - a packet that the unit transmits because the GTP policy allows it
l Prohibited - a packet that the unit drops because the GTP policy denies it
l Rate-limited - a packet that the unit drops because it exceeds the maximum rate limit of the destination GSN
l State-invalid - a packet that the unit drops because it failed stateful inspection
l Tunnel-limited - a packet that the unit drops because the maximum limit of GTP tunnels for the destination GSN

is reached.

The following information is contained in each log entry:

l Timestamp
l Source IP address
l Destination IP address
l Tunnel Identifier (TID) or Tunnel Endpoint Identifier (TEID)
l Message type
l Packet status: forwarded, prohibited, state-invalid, rate-limited, or tunnel-limited
l Virtual domain ID or name
l Reason to be denied if applicable.
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GTP performance

There are independent Receive and Transmit queues for gtp-u process. These queues are and their associated
resources are initialized when the ftp-enhance-mode is enabled.

CLI changes under system npu

gtp-enhance-mode

config system npu
set gtp-enhance-mode [enable|disable]
end

This configuration requires a reboot of the device to initialize the changes.

gtp-enhance-cpu-range

This is used to set the CPUs which can process the GTP-U packet inspection.

config system npu
set gtp-enhance-cpu-range [0|1|2]
end

Option Description

0 Inspect GTPU packets by all CPUs

1 Inspect GTPU packets by Master CPUs

2 Inspect GTPU packets by Slave CPUs

Diagnose commands

diagnose npu np6 hbq-stats [all|np xx]
Used to see the GTP-U packet counter by all NP or the corresponding np.

diagnose npu np6 hbq-stats-clear all /np xx

Used to clear the GTP-U packet counter by all NP or the corresponding np.

Verifying the enhance-mode is disabled

Before execute the test or enable/disable the gtp enhance, first check the gtp-enhance-mode status as in the
example below:

config system npu
get
gtp-enhance-mode: disable
gtp-enhance-cpu-range: 0
end
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If the gtp-enhance-mode is disable, use the command diagnose npu np6 hbq-stats all.

The output will be similar to below:

# diagnose npu np6 hbq-stats all
Total :0

If the gtp-enhance-mode is enable, use the command diagnose npu np6 hbq-stats all

The output will be similar to below:

# diagnose npu np6 hbq-stats all
cpu_ 0:0
cpu_ 1:0
cpu_ 2:0
cpu_ 3:0
cpu_ 4:0
cpu_ 5:0
cpu_ 6:0
cpu_ 7:0
cpu_ 8:0
cpu_ 9:0
cpu_10:0
cpu_11:0
cpu_12:0
cpu_13:0
cpu_14:0
cpu_15:0
cpu_16:0
cpu_17:0
cpu_18:0
cpu_19:0
cpu_20:0
cpu_21:0
cpu_22:0
cpu_23:0
cpu_24:0
cpu_25:0
cpu_26:0
cpu_27:0
cpu_28:0
cpu_29:0
cpu_30:0
cpu_31:0
cpu_32:0
cpu_33:0
cpu_34:0
cpu_35:0
cpu_36:0
cpu_37:0
cpu_38:0
cpu_39:0
Total :0

Sometimes, when loading the new configure file, and the new configure file does not match the old configure file,

the gtp-enhance-mode status will be confused.
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You can see :

#config system npu
#get
gtp-enhance-mode: enable

but you can also see that

diagnose npu np6 hbq-stats all
Total :0

This means the gtp-enhance-mode is actually set to disable.

The inverse is also possible, when you see

#config system npu
#get
gtp-enhance-mode: disable

but you also see that

# diagnose npu np6 hbq-stats all
cpu_ 0:0
...
cpu_39:0
Total :0

This means the gtp-enhance-mode is actually set to enable.

If these combinations occur, just run the command below:

config system npu
set gtp-enhance-mode enable
end

or

config system npu
set gtp-enhance-mode disable
end

Once this is done,reboot the device to let the 2 statuses match.
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Configuring GTP on FortiOS Carrier
Configuring GTP support on FortiOS Carrier involves configuring a number of areas of features.

GTP support on the Carrier-enabled FortiGate unit

The FortiCarrier unit needs to have access to all traffic entering and exiting the carrier network for scanning,
filtering, and logging purposes. This promotes one of two configurations— hub and spoke, or bookend.

A hub and spoke configuration with the Carrier-enabled FortiGate unit at the hub and the other GPRS devices on
the spokes is possible for smaller networks where a lower bandwidth allows you to divide one unit into multiple
virtual domains to fill multiple roles on the carrier network. It can be difficult with a single FortiOS Carrier as the
hub to ensure all possible entry points to the carrier network are properly protected from potential attacks such as
relayed network attacks.

A bookend configuration uses two Carrier-enabled FortiGate units to protect the carrier network between them
with high bandwidth traffic. One unit handles traffic from mobile stations, SGSNs, and foreign carriers. The other
handles GGSN and data network traffic. Together they ensure the network is secure.

The Carrier-enabled FortiGate unit can access all traffic on the network. It can also verify traffic between devices,
and verify that the proper GPRS interface is being used. For example there is no reason for a Gn interface to be
used to communicate with a mobile station — the mobile station will not know what to do with the data — so that
traffic is blocked.

When you are configuring your Carrier-enabled FortiGate unit’s GTP profile, you must
first configure the APN. It is critical to GTP communications— no traffic will flow
without the APN.
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The Carrier-enabled FortiGate unit does more than just forward and route GTP packets over the network. It also
performs:

l GTP support on the Carrier-enabled FortiGate unit
l GTP support on the Carrier-enabled FortiGate unit
l GTP support on the Carrier-enabled FortiGate unit
l GTP support on the Carrier-enabled FortiGate unit
l GTP support on the Carrier-enabled FortiGate unit

Packet sanity checking

The FortiOS Carrier firewall checks the following items to determine if a packet confirms to the UDP and GTP
standards:

l GTP release version number— must be 0, 1, or 2
l Settings of predefined bits
l Protocol type
l UDP packet length

If the packet in question does not confirm to the standards, the FortiOS Carrier firewall drops the packet, so that
the malformed or forged traffic will not be processed.

GTP stateful inspection

Apart from the static inspection (checking the packet header), the FortiOS Carrier firewall performs stateful
inspection.

Stateful inspection provides enhanced security by keeping track of communications sessions and packets over a
period of time. Both incoming and outgoing packets are examined. Outgoing packets that request specific types
of incoming packets are tracked; only those incoming packets constituting a proper response are allowed through
the firewall.

The FortiOS Carrier firewall can also index the GTP tunnels to keep track of them.

Using the enhanced Carrier traffic policy, the FortiOS Carrier firewall can block unwanted encapsulated traffic in
GTP tunnels, such as infrastructure attacks. Infrastructure attacks involve attempts by an attacker to connect to
restricted machines, such as GSN devices, network management systems, or mobile stations. If these attempts
to connect are detected, they are to be flagged immediately by the firewall .

Protocol anomaly detection and prevention

The FortiOS Carrier firewall detects and optionally drops protocol anomalies according to GTP standards and
specific tunnel states. Protocol anomaly attacks involve malformed or corrupt packets that typically fall outside of
protocol specifications. These packets are not seen on a production network. Protocol anomaly attacks exploit
poor programming practices when decoding packets, and are typically used to maliciously impair system
performance or elevate privileges.

FortiOS Carrier also detects IP address spoofing inside GTP data channel.

See Protocol anomaly detection and prevention.
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HA

FortiOS Carrier active-passive HA provides failover protection for the GTP tunnels. This means that an active-
passive cluster can provide FortiOS Carrier firewall services even when one of the cluster units encounters a
problem that would result in complete loss of connectivity for a stand-alone FortiOS Carrier firewall. This failover
protection provides a backup mechanism that can be used to reduce the risk of unexpected downtime, especially
for mission-critical environments.

FortiOS HA synchs TCP sessions by default, but UDP sessions are not synchronized by default. However
synchronizing a session is only part of the solution if the goal is to continue GTP processing on a synchronized
session after a HA switch. For that to be successful we also need to synch the GTP tunnel state. So, once the
master completes tunnel setup then the GTP tunnel is synchronized to the slave.

GTP traffic will only flow without interruption on a HA switch if bidirectional GTP policies have been configured:
an internal (GTP server) to external (all) UDP port GTP policy, and an external (all) to internal (GTP server) UDP
port GTP policy. If either policy is missing then traffic may be interrupted until traffic flows in the opposite
direction.

For more information on HA in FortiOS, see the High Availability (HA) Guide or the FortiOS Administration Guide.

Virtual domain support

FortiOS Carrier is suited to both large and smaller carriers. A single Carrier-enabled FortiGate unit can serve
either one large carrier, or several smaller ones through virtual domains. As with any FortiGate unit, Carrier-
enabled units have the ability to split their resources into multiple virtual units. This allows smaller carriers to use
just the resources that they need without wasting the extra. For more information on HA in FortiOS, see the
Virtual Domains (VDOMs) Guide.

Configuring General Settings on the Carrier-enabled FortiGate unit

To configure the GTPGeneral Settings, go to Security Profiles > GTP Profile, and edit a GTP profile. Expand
General Settings to configure settings. See General settings options.

GTP Monitor Mode

The monitor-mode setting is part of the GTP profile. The setting shows on all GTP profiles and works for all
GTP versions.

When this setting is enabled, if a GTP packet is to be dropped due to a GTP deny case such as:

l GTP_DENY
l GTP_RATE_LIMIT
l GTP_STATE_INVALID
l GTP_TUNNEL_LIMIT

instead of being dropped, it will be forwarded and logged with the original deny log message and a "-monitor"
suffix (e.g., state-invalid-monitor).

This setting is found in the CLI.

config firewall gtp
edit profile_name

...
set monitor-mode [disable*|enable]
...
end
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end

Configuring Encapsulated Filtering in FortiOS Carrier

Encapsulated traffic on the GPRS network can come in a number of forms as it includes traffic that is “wrapped
up” in another protocol. This detail is important for firewalls because it requires “unwrapping” to properly scan the
data inside. If encapsulated packets are treated as regular packets, that inside layer will never be scanned and
may allow malicious data into your network.

On Carrier-enabled FortiGate units, GTP related encapsulated filtering falls under encapsulated IP traffic
filtering, and encapsulated non-IP end user address filtering.

Configuring Encapsulated IP Traffic Filtering

Generally there are a very limited number of IP addresses that are allowed to encapsulate GPRS traffic. For
example GTP tunnels are a valid type of encapsulation when used properly. This is the GTP tunnel which uses
the Gp or Gn interfaces between SGSNs and GGSNs. However, a GTP tunnel within a GTP tunnel is not
accessible — FortiOS Carrier will either block or forward the traffic, but is not able to open it for inspection.

The ability to filter GTP sessions is based on information contained in the data stream and provides operators
with a powerful mechanism to control data flows within their infrastructure. You can also configure IP filtering
rules to filter encapsulated IP traffic from Mobile Stations.

To configure the Encapsulated IP Traffic Filtering, go to Security Profiles > GTP Profile, and edit a GTP
profile. Expand Encapsulated IP Traffic Filtering to configure settings. See Encapsulated IP traffic filtering
options.

When to use encapsulated IP traffic filtering

The following are the typical cases that need encapsulated IP traffic filtering:

Mobile station IP pools

In a well-designed network, best practices dictate that the mobile station address pool is to be completely
separate from the GPRS network infrastructure range of addresses. Encapsulated IP packets originating from a
mobile station will not contain source or destination addresses that fall within the address range of GPRS
infrastructures. In addition, traffic originating from the users handset will not have destination/source IP
addresses that fall within any Network Management System (NMS) or Charging Gateway (CG) networks.

Communication between mobile stations

Mobile stations on the same GPRS network are not able to communicate with other mobile stations. Best
practices dictate that packets containing both source and destination addresses within the mobile station's range
of addresses are to be dropped.

Direct mobile device or internet attacks

It may be possible for attackers to wrap attack traffic in GTP protocols and submit the resulting GTP traffic
directly to a GPRS network element from their mobile stations or a node on the Internet. It is possible that the
receiving SGSN or GGSN would then strip off the GTP header and attempt to route the underlying attack. This
underlying attack could have any destination address and would probably have a source address spoofed as if it
were valid from that PLMN.
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You cannot add an IE removal policy when you are creating a new profile.

Relayed network attacks

Depending on the destination the attack could be directly routed, such as to another node of the PLMN, or re
wrapped in GTP for transmission to any destination on the Internet outside the PLMN depending on the routing
table of the GSN enlisted as the unwitting relay.

The relayed attack could have any source or destination addresses and could be any of numerous IP network
attacks, such as an attack to hijack a PDP context, or a direct attack against a management interface of a GSN or
other device within the PLMN. Best practices dictate that any IP traffic originating on the Internet or from an MS
with a destination address within the PLMN is to be filtered.

Configuring Encapsulated Non-IP End User Address Filtering

Much of the traffic on the GPRS network is in the form of IP traffic. However some parts of the network do not
used IP based addressing, so the Carrier-enabled FortiGate unit is unable to perform Encapsulated IP Traffic
Filtering.

Depending on the installed environment, it may be beneficial to detect GTP packets that encapsulate non-IP
based protocols. You can configure the FortiOS Carrier firewall to permit a list of acceptable protocols, with all
other protocols denied.

The encoded protocol is determined in the PDP Type Organization and PDP Type Number fields within the End
User Address Information Element. The PDP Type Organization is a 4-bit field that determines if the protocol is
part of the ETSI or IETF organizations. Values are zero and one, respectively. The PDP Type field is one byte
long. Both GTP specifications only list PPP, with a PDP Type value of one, as a valid ETSI protocol. PDP Types
for the IETF values are determined in the "Assigned PPPDLL Protocol Numbers" sections of RFC 1700. The PDP
types are compressed, meaning that the most significant byte is skipped, limiting the protocols listed from 0x00
to 0xFF.

To configure the Encapsulated Non-IP End User Address Filtering, go to Security Profiles > GTP Profile, and
edit a GTP profile. Expand Encapsulated Non-IP End User Address Filtering to configure settings. See
Encapsulated non-IP end user traffic filtering options.

Configuring the Protocol Anomaly feature in FortiOS Carrier

When anomalies do happen, it is possible for the anomaly to interrupt network traffic or consume network
resources— if precautions are not taken. Anomalies can be generated by accident or maliciously, but both
methods can have the same results— degrading the performance of the carrier network, or worse.

To configure GTP protocol anomalies, go to Security Profiles > GTP Profile, and edit a GTP profile. Expand
the Protocol Anomaly option. See Protocol Anomaly prevention options.

The following are some examples:

l The GTP header specifies the length of the packet excluding the mandatory GTP header. In GTP version 0 (GSM
09.60), the mandatory GTP header size is 20 bytes, whereas GTP version 1 (GSM 29.060) specifies that the
minimum length of the GTP header is 8 bytes. The GTP packet is composed of the header, followed by Information
Elements typically presented in a Type-Length-Value format. It is possible for an attacker to create a GTP packet
with a GTP header field length that is incompatible with the length of the necessary information elements.
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l The same concepts are true for GTP version 2 headers even though there are different fields in them.
l It is similarly possible for an attacker to create a packet with an invalid IE length. Invalid lengths may cause protocol

stacks to allocate incorrect amounts of memory, and thereby cause crashes or buffer overflows.

By default the FortiOS Carrier firewall detects these problems, as well as other protocol anomalies, and drops the
packets. All protocol anomaly options are set to Deny by default. However, you can change the policy to allow
them.

Configuring Anti-overbilling in FortiOS Carrier

GPRS over billing attacks can be prevented with a properly configured Carrier-enabled FortiGate unit.

Over billing can occur when a subscriber returns his IP address to the IP pool. Before the billing server closes it,
the subscriber's session is still open and vulnerable. If an attacker takes control of the subscriber's IP address, he
can send or receive data and the subscriber will be billed for the traffic.

Over billing can also occur when an available IP address is reassigned to a new mobile station (MS). Subsequent
traffic by the previous MSmay be forwarded to the new MS. The new MSwould then be billed for traffic it did not
initiate.

Anti-overbilling with FortiOS Carrier

The Carrier-enabled FortiGate unit can be configured to assist with anti-overbilling measures. These measures
ensure that the customer is only billed for connection time and data transfer that they actually use.

Anti-overbilling on the Carrier-enabled FortiGate unit involves:

l the administrator configuring the over billing settings in the GTP profile to notify the Gi firewall when a GTP tunnel
is deleted

l the unit clearing the sessions when the Gi firewall receives a notification from the Gn/Gp firewall about a GTP
tunnel being deleted This way, the Gi firewall prevents over billing by blocking traffic initiated by other users.

The three locations to configure anti-overbilling options include:

l Network > Interface— Edit a specific interface. Towards the bottom of the Edit Interface page, in the Status
section, you can toggleGi Gatekeeper.

l System > Settings— In theGi Gatekeeper Settings section, set the Context ID and Port that anti-overbilling
will take place on.

l Security Profiles > GTP Profile— Edit a specific GTP Profile. In the Anti-Overbilling section, edit theGi
Firewall IP address, Port, Interface and Security Context ID, to use for anti-overbilling measures.

For detailed options, see Anti-Overbilling options.

Logging events on the Carrier-enabled FortiGate unit

Logging on the Carrier-enabled FortiGate unit is just like logging on any other FortiOS unit. The only difference
with FortiOS Carrier is that there are a few additional events that you can log beyond the regular ones. These
additional events are covered here.

To change FortiOS Carrier specific logging event settings, go to Security Profiles > GTP Profile and edit a
GTP profile. Expand the Log section to change the settings. For detailed options, see Log options.

The following information is contained in each log entry:
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Timestamp The time and date when the log entry was recorded

Source IP address The sender’s IP address.

Destination IP address The reciever’s IP address. The sender-receiver pair includes a mobile
phone on the GPRS local network, and a device on a network external to
the GPRS network, such as the Internet.

Tunnel Identifier (TID)

Tunnel Endpoint Identifier
(TEID)

An identifier for the start and endpoints of a GTP tunnel. This information
uniquely defines all tunnels. It is important for billing information based
on the length of time the tunnel was active and how much data passed
over the tunnel.

Message type For available message types, see Common message types on carrier
networks.

Packet status

What action was performed on the packet. This field matches the logging
options while you are configuring GTP logging. See Logging events on
the Carrier-enabled FortiGate unit on page 876.

The status can be one of forwarded, prohibited, state-invalid, rate-limited,
or tunnel-limited

Virtual domain ID or name ACarrier-enabled FortiGate unit can be divided into multiple virtual units,
each being a complete and self-contained virtual FortiCarrier unit. This
field indicates which virtual domain (VDOM) was responsible for the log
entry. If VDOMs are not enabled on your unit, this field will be root.

Reason to be denied if
applicable

If the packet that generated this log entry was denied or blocked, this field
will include what part of FortiOS denied or blocked that packet. Such as
firewall, antivirus, webfilter, or spamfilter.

An example of the above log message format is for a Tunnel deleted log entry. When a tunnel is deleted, the log
entry contains the following information:

l Timestamp
l Interface name (if applicable)
l SGSN IP address (source IP)
l GGSN IP address (destination IP)
l Tunnel ID
l Tunnel duration time in seconds
l Number of messages sent to the SGSN
l Number of messages sent to the GGSN

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

877



GTPConfiguration Chapter 7 - FortiOS Carrier

GTP message type filtering
FortiOS Carrier supports message filtering in GTP by the type of message.

This section includes:

Common message types on carrier networks

Carrier networks include many types of messages— some concern the network itself, others are content moving
across the network, and still others deal with handshaking, billing, or other administration based issues.

GTP contains two major parts GTP for the control plane (GTP-C) and GTP for user data tunnelling (GTP-U).
Outside of those areas there are only unknown message types.

GTP-C messages

GTP-C contains the networking layer messages. These address routing, versioning, and other similar low level
issues.

When a subscriber requests a Packet Data Protocol (PDP) context, the SGSN will send a create PDP context
request GTP-C message to the GGSN giving details of the subscriber's request. The GGSN will then respond
with a create PDP context response GTP-C message which will either give details of the PDP context actually
activated or will indicate a failure and give a reason for that failure. This is a UDPmessage on port 212.

GTP-C message types include Path Management Messages, Location Management Messages, and Mobility
Management Messages.

Path Management Messages

Path management is used by one GSN to detect if another GSN is alive, or if it has restarted after a failure.

The path management procedure checks if a given GSN is alive or has been restarted after a failure. In case of
SGSN restart, all MM and PDP contexts are deleted in the SGSN, since the associated data is stored in a volatile
memory. In the case of GGSN restart, all PDP contexts are deleted in the GGSN.

Tunnel Management Messages

The tunnel management procedures are used to create, update, and delete GTP tunnels in order to route IP
PDUs between an MS and an external PDN via the GSNs.

The PDP context contains the subscriber's session information when the subscriber has an active session. When
a mobile wants to use GPRS, it must first attach and then activate a PDP context. This allocates a PDP context
data structure in the SGSN that the subscriber is currently visiting and the GGSN serving the subscriber's access
point.

Tunnel management procedures are defined to create, update, and delete tunnels within the GPRS backbone
network. A GTP tunnel is used to deliver packets between an SGSN and a GGSN. AGTP tunnel is identified in
each GSN node by a TEID, an IP address, and a UDP port number.

Location Management Messages

The location-management procedure is performed during the network-requested PDP context activation
procedure if the GGSN does not have an SS7 MAP interface (i.e., Gc interface). It is used to transfer location
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messages between the GGSN and a GTP-MAP protocol-converting GSN in the GPRS backbone network.

Location management subprocedures are used between a GGSN that does not support an SS7 MAP interface
(i.e., Gc interface) and a GTP-MAP protocol-conversing GSN. This GSN supports both Gn and Gc interfaces and
is able to perform a protocol conversing between GTP and MAP.

Mobility Management Messages

The MM procedures are used by a new SGSN in order to retrieve the IMSI and the authentication information or
MM and PDP context information in an old SGSN. They are performed during the GPRS attach and the inter-
SGSN routing update procedures.

The MM procedures are used between SGSNs at the GPRS-attach and inter-SGSN routing update procedures.
An identity procedure has been defined to retrieve the IMSI and the authentication information in an old SGSN.
This procedure may be performed at the GPRS attach. A recovery procedure enables information related to MM
and PDP contexts in an old SGSN to be retrieved. This procedure is started by a new SGSN during an inter-SGSN
RA update procedure.

GTP-U messages

GTP-U is focused on user related issues including tunneling, and billing. GTP-U message types include MBMS
messages, and GTP-U and Charging Management Messages

MBMS messages

Multimedia Broadcast and Multicast Services (MBMS) have recently begun to be offered over GSM and UMTS
networks on UTRAN and GERAN radio access technologies. MBMS is mainly used for mobile TV, using up to four
GSM timeslots for one MBMS connection. One MBMS packet flow is replicated by GGSN, SGSN and RNCs.

MBMS is split into the MBMSBearer Service and the MBMSUser Service. The MBMSUser Service is basically
the MBMSService Layer and offers a Streaming- and a Download Delivery Method. The Streaming Delivery
method can be used for continuous transmissions like Mobile TV services. The Download Method is intended for
"Download and Play" services.

GTP-U and Charging Management Messages

SGSNs and GGSNs listen for GTP-U messages on UDP port 2152.

GTP‘ (GTP prime) is used for billing messages. It uses the common GTPmessages (GTP Version Not
Supported, Echo Request and Echo Response) and adds additional messages related to billing procedures.

Unknown Action messages

If the system doesn’t know what type of message it is, it falls into this category. This is an important category of
message because malformed messages may appear and need to be handled with security in mind.

Fortinet best practices dictate that you set Unknown Action messages to deny for
security reasons.
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Configuring message type filtering in FortiOS Carrier

GPRS Tunnelling Protocol (GTP) is a group of IP-based communications protocols used to carry General Packet
Radio Service (GPRS) traffic within Global System for Mobile Communications (GSM) and Universal Mobile
Telecommunications System (UMTS) networks. It allows carriers to transport actual cellular packets over their
network via tunneling.

In the CLI, there is a keyword for each type of GTPmessage for both message filtering, and for message rate
limiting.

GTPmessage rate limiting is only accessible from the CLI using the command
configure firewall gtp.

To configure GTP message type filtering - web-based manager

1. Go to Security Profiles > GTP Profile.
2. Select Create New.
3. Enter a name for this profile such as msg_type_filtering.
4. Select Message Type Filtering to expand it.
5. For each type of message in the list, select Allow or Deny. All messages are set to Allow by default.

Fortinet best practices dictate that the unknown message action should be set to
Deny for security reasons as this will block malformed messages.

6. Optionally select and configure any other GTP features for this profile, such as logging.
7. Select OK to save the profile.
8. Apply the msg_type_filtering profile a security policy configured for GTP tunnel traffic.

To configure GTP message filtering and block Unknown Message Action messages- CLI

config firewall gtp
edit msg_type_filtering

config message-filter
set unknown-message-action deny

next
end

end

Message Type Fields

Each of the following message types can be allowed or denied by your Carrier-enabled FortiGate unit depending
on your carrier network and GTP traffic.

Unknown Message Action

Set this message type to deny.
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Many attempts to hack into a carrier network will result in this unknown message type and therefore it is denied
for security reasons.

Path Management Messages

Message Type Used by Description

Echo Request/Response GTP-C,
GTP-U,
GTP’

Echo Request is sent on a path to another GSN to determine if
the other node is alive. Echo Response is the reply.

Version not Supported
GTP-C,
GTP-U,
GTP’

There are multiple versions of GTP. Both devices
communicating must use the same version of GTP, or this
message will be the response.

Support Extension Headers
Notification

Extensions are optional parts that a device can choose to
support or not. If a device includes these extensions, it must
include headers for the extensions to sure ensure proper
formatting.

Tunnel Management Messages

Message Type Used by Description

Create PDPContext Request/
Response

GTP-C Sent from an SGSN to a GGSN node as part of a GPRS PDP
Context Activation procedure or the Network-Requested PDP
Context Activation procedure. A valid request initiates the
creation of a tunnel.

Update PDPContext Request/
Response GTP-C Used when PDPContext information changes, such as when a

mobile device changes location.

Delete PDPContext Request/
Response

GTP-C Used to terminate a PDPContext, and confirm the context has
been deleted.

Create AA PDPContext
Request/ Response GTP-C

Sent as part of the GPRS Anonymous Access PDPContext
Activation. It is used to create a tunnel between a context in the
SGSN and a context in the GGSN.

Delete AA PDPContext
Request/ Response

GTP-C Sent as part of the GPRS PDPAnonymous Access Context
Deactivation procedure to deactivate an activated PDPContext.
It contains Cause and Private Extension Information Elements

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

881



GTPConfiguration Chapter 7 - FortiOS Carrier

Message Type Used by Description

Error Indication GTP-U

Sent to the GGSN when a tunnel PDU is received for the
following conditions:

— No PDP context exists
— PDP context is inactive
— No MM context exists
— GGSN deletes its PDP context when the message is
received.

PDU Notification Request/
Response/ Reject Request/
Reject Response

GTP-C When receiving a Tunneled PDU (T-PDU), the GGSN checks if
a PDP context is established for the given PDP address. If no
PDP context has been established, the GGSNmay initiate the
Network-requested PDPContext Activation procedure by
sending a PDU Notification Request to the SGSN.

Reject Request - Sent when the PDP context requested by the
GGSN cannot be established.

Location Management Messages

Message Type Used
By Description

Send Routing Information for
GPRSRequest/ Response

GTP-C Sent by the GGSN to obtain location information for the MS.
This message type contains the IMSI of the MS and Private
Extension.

Failure Report Request/
Response GTP-C

Sent by the GGSN to the HLR when a PDU reject message is
received.

The GGSN requests the HLR to set the flag and add the GGSN
to the list of nodes to report to when activity from the subscriber
that owns the PDP address is detected.

The message contains the subscriber IMSI and Private
Extension

Note MSGPRSPresent
Request/ Response

GTP-C When the HLR receives a message from a mobile with MDFG

set, it clears the MDFG and sends the Note MS Present
message to all GGSN’s in the subscriber’s list.

This message type contains subscriber IMSI, GSN Address and
Private Extension
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Mobility Management Messages

Message Type Used
By Description

Identification
Request/Response

GTP-C Sent by the new SGSN to the old SGSN to request the IMSI for
a MSwhen a GPRSAttach is done with a P-TMSI and the MS
has changed SGSNs since the GPRSDetach was done.

SGSN context Request/
Response/ Acknowledge GTP-C Sent by the new SGSN to the old SGSN to request the MM and

PDPContexts for the MS.

Forward Relocation Request/
Response/ Complete/
Complete Acknowledge

GTP-C Indicates mobile activation/deactivation within a Routing Area.
This prevents paging of a mobile that is not active (visited VLR
rejects calls from the HLR or applies Call Forwarding). Note that
the mobile station does not maintain an attach/detach state.

SRNS contexts contain for each concerned RAB the sequence
numbers of the GTP-PDUs next to be transmitted in uplink and
downlink directions.

Relocation Cancel Request/
Response GTP-C Send to cancel the relocation of a connection.

Forward SRNSContext/
Context Acknowledge

GTP-C This procedure may be used to trigger the transfer of SRNS
contexts from RNC to CN (PS domain) in case of inter system
forward handover.

RAN Information Relay GTP-C

Forward the Routing Area Network (RAN) information.

A Routing Area (RA) is a subset of a GSM Location Area (LA). A
RA is served by only one SGSN. Ensures that regular radio
contact is maintained by the mobile

MBMS messages

Message Type Used
By Description

MBMSNotification Request/
Response/ Reject Request/
Reject Response

GTP-C Notification of the radio access devices.

Create MBMSContext
Request/ Response GTP-C

Request to create an active MBMS context. The context will be
pending until the response is received.

Once active, the MBMS context allows the MS to receive data
from a specific MBMS source
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Message Type Used
By Description

Update MBMSContext
Request/ Response

GTP-C

Delete MBMSContext
Request/ Response GTP-C Request to deactivate the MBMS context. When the response is

received, the MBMS context will be inactive.

GTP-U and Charging Management Messages

Message Type Used
By Description

G-PDU GTP-C,
GTP-U

GPRSPacket data unit delivery message.

Node Alive Request/Response GTP-C,
GTP-U Used to inform rest of network when a node starts service.

Redirection
Request/Response

GTP-C,
GTP-U

Used to divert the flow of CDRs from the CDFs to another CGF
when the sender is being removed, or they are used when the
CGF has lost its connection to a downstream system.

Data Record Transfer
Request/Response

GTP-C,
GTP-U

Used to reliably transport CDRs from the point of generation
(SGSN/GGSN) to non-volatile storage in the CGF
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GTP identity filtering
FortiOS Carrier supports a number of filtering methods based on subscriber identity such as APN filtering, IMSI
filtering, and advanced filtering.

This section includes:

IMSI on carrier networks

The International Mobile Subscriber Identity (IMSI) number is central to identifying users on a carrier network. It is
a unique number that is assigned to a cell phone or mobile device to identify it on the GMS or UTMS network.

Typical the IMSI number is stored on the SIM card of the mobile device and is sent to the network as required.

An IMSI number is 15 digits long, and includes the Mobile Country Code (MCC), Mobile Network Code (MNC),
and Mobile Station Identification Number (MSIN).

IMSI codes

The Home Network Identity (HNI) is made up of the MCC and MNC. The HNI is used to fully identify a user’s
home network. This is important because some large countries have more than one country code for a single
carrier. For example a customer with a mobile carrier on the East Coast of the United States would have a
different MCC than a customer on the West Coast with the same carrier because even through the MNC would
be the same the MCC would be different — the United States uses MCCs 310 to 316 due to its size.

If an IMSI number is not from the local carrier’s network, IMSI analysis is performed to resolve the number into a
Global Title which is used to access the user’s information remotely on their home carrier’s network for things like
billing and international roaming.

Other identity and location based information elements

IMSI focuses on the user, their location, and carrier network. There are other numbers used to identify different
user related Information Elements (IE).

These identity and location based elements include:

l Access Point Number (APN)
l Mobile Subscriber Integrated Services Digital Network (MSISDN)
l Radio Access Technology (RAT) type
l User Location Information (ULI)
l Routing Area Identifier (RAI)
l International Mobile Equipment Identity (IMEI)
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Access Point Number (APN)

The Access Point Number (APN) is used in GPRS networks to identify an IP packet data network that a user
wants to communicate with. The Network Identifier describes the network and optionally the service on that
network that the GGSN is connected to. The APN also includes the MCC and MCN, which together locate the
network the GGSN belongs to. An example of an APN in the Barbados using Digicel as the carrier that is
connecting to the Internet is internet.mcc342.mnc750.gprs.

When you are configuring your Carrier-enabled FortiGate unit’s GTP profiles, you must first configure the APN. It
is critical to GTP communications and without it no traffic will flow.

The access point can then be used in a DNS query to a private DNS network. This process (called APN resolution)
gives the IP address of the GGSN which serves the access point. At this point a PDP context can be activated.

Mobile Subscriber Integrated Services Digital Network (MSISDN)

This is a 15-digit number that, along with the IMSI, uniquely identifies a mobile user. Normally this number
includes a 2-digit country code, a 3-digit national destination code, and a 10-digit subscriber number or the phone
number of the mobile device, and because of that may change over time if the user changes their phone number.
The MSISDN number follows the ITU-T E.164 numbering plan.

Radio Access Technology (RAT) type

The RAT type represents the radio technology used by the mobile device. This can be useful in determining what
services or content can be sent to a specific mobile device. FortiOS Carrier supports:

l UMTS Terrestrial Radio Access Network (UTRAN), commonly referred to as 3G, routes many types of traffic
including IP traffic. This is one of the faster types.

l GSM EDGE Radio Access Network (GERAN) is a key part of the GSM network which routes both phone calls
and data.

l Wireless LAN (WLAN) is used but not as widely as the other types. It is possible for the mobile device to move
from one WLAN to another such as from an internal WLAN to a commercial hot spot.

l Generic Access Network (GAN) can also be called unlicensed mobile access (UMA). It routes voice, data, and
SIP over IP networks. GAN is commonly used for mobile devices that have a dual-mode and can hand-off between
GSM and WLANs.

l High Speed Packet Access (HSPA) includes two other protocols High Speed Downlink and Uplink Packet
Access protocols (HSDPA and HSUPA respectively). It improves on the older WCDMA protocols by better using the
radio bandwidth between the mobile device and the radio tower. This results in an increased data transfer rate for
the user.

RAT type is part of advanced filtering configuration. See Configuring advanced filtering in FortiOS Carrier.

User Location Information (ULI)

Gives Cell Global Identity/Service Area Identity (CGI/SAI) of where the mobile station is currently located. The
ULI and the RAI are commonly used together to identify the location of the mobile device.

ULI is part of advanced filtering configuration. See Configuring advanced filtering in FortiOS Carrier.
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Routing Area Identifier (RAI)

Routing Areas (RAs) divide the carrier network and each has its own identifier (RAI). When a mobile device moves
from one routing area to another, the connection is handled by a different part of the network. There are normally
multiple cells in a routing area. There is only one SSGN per routing area. The RAI and ULI are commonly used to
determine a user’s location.

RAI is part of advanced filtering configuration. See Configuring advanced filtering in FortiOS Carrier.

International Mobile Equipment Identity (IMEI)

IMEI is a unique 15-digit number used to identify mobile devices on mobile networks. It is very much like the MAC
address of a TCP/IP network card for a computer. It can be used to prevent network access by a stolen phone—
the carrier knows the mobile phone’s IMEI, and when it is reported stolen that IMEI is blocked from accessing the
carrier network no matter if it has the same SIM card as before or not. It is important to note that the IMEI stays
with the mobile phone or device where the other information is either location based or stored on the removable
SIM card.

IMEI type is part of advanced filtering configuration. See Configuring advanced filtering in FortiOS Carrier.

When to use APN, IMSI, or advanced filtering

At first glance APN, IMSI, and advanced filtering have parts in common. For example two can filter on APN, and
another two can filter on IMSI. The difficulty is knowing when to use which type of filtering.

Identity filtering comparison

Filtering type Filter on the following data: When to use this type of filtering

APN APN Filter based on GTP tunnel start or destination

IMSI IMSI, MCC-MNC Filter based on subscriber information

Advanced PDP context, APN, IMSI,
MSISDN, RAT type, ULI, RAI,
IMEI

When you want to filter based on:

•  user phone number (MSISDN)
•  what wireless technology the user employed •  to
get on the network (RAT type)
•  user location (ULI and RAI)
•  handset ID, such as for stolen phones (IMEI)

APN filtering is very specific — the only identifying information that is used to filter is the APN itself. This will
always be present in GTP tunnel traffic, so all GTP traffic can be filtered using this value.

IMSI filtering can use a combination of the APN and MCC-MNC numbers. The MCC and MNC are part of the
APN, however filtering on MCC-MNC separately allows you to filter based on country and carrier instead of just
the destination of the GTP Tunnel.

Advanced filtering can go into much deeper detail covering PDP contexts, MSISDN, IMEI, and more not to
mention APN, and IMSI as well. If you can’t find the information in APN or IMSI that you need to filter on, then
use Advanced filtering.
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Configuring APN filtering in FortiOS Carrier

To configure APN filtering go to Security Profiles > GTP Profile. Select a profile or create a new one, and
expand APN filtering.

When you are configuring your Carrier-enabled FortiGate unit’s GTP profiles, you
must first configure the APN. It is critical to GTP communications and without it no
traffic will flow.

Enable APN Filter Select to enable filtering based on APN value.

Default APN Action Select either Allow or Deny for all APNs that are not found in the list. The
default is Allow.

Value Displays the APN value for this entry. Partial matches are allowed using
wildcard. For example *.mcc333.mcn111.gprs would match all APNs
from country 333 and carrier 111 on the gprs network.

Mode

Select one or more of the methods used to obtain APN values.

Mobile Station provided - The APN comes from the mobile station where
the mobile device connected. This is the point of entry into the carrier
network for the user’s connection.

Network provided - The APN comes from the carrier network.

Subscription Verified - The user’s subscription has been verified for this
APN. This is the most secure option.

Action One of allow or deny to allow or block traffic associated with this APN.

Delete icon Select to remove this APN entry from the list.

Edit icon Select to change the information for this APN entry.

Add APN

Select to add an APN to the list. Not active while creating GTP profile, only
when editing an existing GTP profile.

Save all changes before adding APNs. A warning to this effect will be
displayed when you select the Add APN button.

The Add APN button is not activated until you save the new GTP profile. When you edit that GTP profile, you will
be able to add new APNs.

Configuring IMSI filtering in FortiOS Carrier

In many ways the IMSI on a GPRS network is similar to an IP address on a TCP/IP network. Different parts of the
number provide different pieces of information. This concept is used in IMSI filtering on FortiOS Carrier.
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To configure IMSI filtering go to Security Profiles > GTP Profile and expand IMSI filtering.

While both the APN and MCC-MCN fields are optional, without using one of these fields the IMSI entry will not be
useful as there is no information for the filter to match.

Enable IMSI Filter Select to turn on IMSI filtering.

Default IMSI Action

Select Allow or Deny. This action will be applied to all IMSI numbers except
as indicated in the IMSI list that is displayed.

The default value is Allow.

APN The Access Point Number (APN) to filter on.

This field is optional.

MCC-MNC

The Mobile Country Code (MCC) and Mobile Network Code (MNC) to filter
on. Together these numbers uniquely identify the carrier and network of the
GGSN being used.

This field is optional.

Mode Select the source of the IMSI information as one or more of the following:

Mobile Station provided - the IMSI number comes from the mobile
station the mobile device is connecting to.

Network provided - the IMSI number comes from the GPRS network
which could be a number of sources such as the SGSN, or HLR.

Subscription Verified - the IMSI number comes from the user’s home
network which has verified the information.

While Subscription Verified is the most secure option, it may not always be
available. Selecting all three options will ensure the most complete
coverage.

Action Select the action to take when this IMSI information is encountered. Select
one of Allow or Deny.

Delete Icon Select the delete icon to remove this IMSI entry.

Edit Icon Select the edit icon to change information for this IMSI entry.

Add IMSI Select to add an IMSI to the list. Not active while creating GTP profile, only
when editing an existing GTP profile.

Save all changes before adding IMSIs. A warning to this effect will be
displayed when you select the Add IMSI button.
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Configuring advanced filtering in FortiOS Carrier

Compared to ADN or IMSI filtering, advanced filtering is well named. Advanced filtering can be viewed as a catch-
all filtering option — if ADN or IMSI filtering doesn’t do what you want, then advanced filtering will. The advanced
filtering can use more information elements to provide considerably more granularity for your filtering.

Enable Select to turn on advanced filtering.

Default Action Select Allow or Deny as the default action to take when traffic does not
match an entry in the advanced filter list .

Messages Optionally select one or more types of messages this filter applies to:

Create PDPContext Request, Create PDPContext Response, Update
PDPContext Request, or Update PDPContext Response.

Selecting Create PDP Context Response orUpdate PDP Context
Response limits RAT type to only GAN and HSPA, and disables
the APN, APN Mode, IMSI, MSISDN, ULI, RAI, and IMEI fields.

To select Update PDP Context Request, APN Restrictionmust be set
to all. Selecting Update PDP Context Request disables the APN,
MSISDN, and IMEI fields.

if all message types are selected, only the RAT Types of GAN and HSPA
are available to select.

APN Restriction

APN Restriction either allows all APNs or restricts the APNs to one of four
categories— Public-1, Public-2, Private-1, or Private-2. This can also be
combined with a specific APN or partial APN as well as specifying the APN
mode.

RAT Type Select one or more of the Radio Access Technology Types listed. These
fields control how a user accesses the carrier’s network. You can select one
or more of UTRAN, GERAN, WLAN, GAN, HSPA, or any.

ULI

The user location identifier. Often the ULI is used with the RAI to locate a
user geographically on the carrier’s network.

The ULI is disabled when Create PDP Context Response orUpdate
PDP Context Responsemessages are selected.

RAI The router area identifier. There is only one SGSN per routing area on a
carrier network. This is often used with ULI to locate a user geographically
on a carrier network.

The RAI is disabled when Create PDP Context Response orUpdate
PDP Context Responsemessages are selected.
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IMEI

The International Mobile Equipment Identity. The IMEI uniquely identifies
mobile hardware, and can be used to block stolen equipment.

The IMEI is only available when Create PDP Context Request or no
messages are selected.

Action Select Allow orDeny as the action when this filter matches traffic.

The default is Allow.

Delete Icon Select to delete this entry from the list.

Edit Icon Select to edit this entry.

Add

Select to add an advanced filter to the list. Not active while creating GTP
profile, only when editing an existing GTP profile.

Save all changes before adding advanced filters. A warning to this effect
will be displayed when you select the Add button.

SCTP Concepts

As of FortiOS version 5.0, the FortiGate natively handles SCTP (Stream Control Transport Protocol) traffic, as an
alternative to TCP and UDP for use in Carrier networks. The FortiGate handles SCTP as if it would any other
traffic.

Overview

SCTP is a connection-oriented transport protocol that overcomes some of the limitations of both TCP and UDP
that prevent reliable transfer of data over IP-based networks (such as those used by telephony systems and
carrier networks). The ‘Stream’ in SCTP refers to the sequence of user messages or packets that are considered
at the same time to be individual objects and also treated as a whole by networked systems. SCTP is less
vulnerable to congestion and flooding due to more advanced error handling and flood protection built into the
protocol.

SCTP features as compared to TCP and UDP

Feature SCTP TCP UDP

State required at each endpoint yes yes no

Reliable data transfer yes yes no

Congestion control and avoidance yes yes no

Message boundary conservation yes no yes

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

891



SCTPConcepts Chapter 7 - FortiOS Carrier

Feature SCTP TCP UDP

Path MTU discovery and message fragmentation yes yes no

Message bundling yes yes no

Multi-homed hosts support yes no no

Multi-stream support yes no no

Unordered data delivery yes no yes

Security cookie against SYN flood attack yes no no

Built-in heartbeat (reachability check) yes no N/A

All of these features are built into the design of the Protocol, and the structure of SCTP packets and networks.
The FortiGate unit interprets the traffic and provides the necessary support for maintenance and verification
features, but the features are not FortiGate specific. These features are documented in greater detail below.

State required at each endpoint

Constant back and forth acknowledgement and content verification messages are sent between all SCTP peer
endpoints, and all endpoints’ state machine actions must be synchronized for traffic to flow.

Reliable data transfer

SCTP places data and control information (eg. source, destination, verification) into separate messages, both
sharing the same header in the same SCTP packet. This allows for constant verification of the contained data at
both ends and along the path, preventing data loss or fragmentation. As well, data is not sent in an interruptible
stream as in TCP.

Congestion control and avoidance

Built-in, constantly updating path detection and monitoring automatically redirect packets along alternate paths in
case of traffic congestion or inaccessible destinations. For deliberate/malicious congestion control, see the below
section on Security cookie against SYN flood attack.

Message boundary conservation

SCTP is designed in such a way that no matter how messages are divided, redirected, or fragmented, the
message boundaries will be maintained within the packets, and all messages cannot be appended without
tripping verification mechanisms.

Path MTU discovery and message fragmentation

SCTP is capable of Path Maximum Transmission Unit discovery, as outlined in RFC4821. Two specific
alterations have been made to how SCTP handles MTU. First, that endpoints will have separate MTU estimates
for each possible multi-homed endpoint. Second, that bundled message fragments (as explained below) will be
directed based on MTU calculations, so that retransmissions (if necessary) will be sent without delay to alternate
addresses.
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Message bundling

SCTP is a message-oriented protocol, which means that despite being a streaming data protocol, it transports a
sequence of specific messages, rather than transporting a stream of bytes (like TCP). Since some data
transmissions are small enough to not require a complete message’s worth of content, so multiple pieces of
content will be transmitted simultaneously within the messages.

Multi-homed hosts support

SCTP supports multi-homing, which is a network structure in which one or multiple sources/destinations has more
than one IP address. SCTP can adapt to multi-homing scenarios and redirect traffic to alternate IP addresses in
case of failure.

Multi-stream support

Due to the message bundling feature allowing for multiple pieces of content to be sent in messages at once,
SCTP can ‘multi-stream’ content, by deliberately dividing it among messages at a fixed rate, so that multiple
types of content (eg. both images and text) can be loaded at once, at the same pace.

Unordered data delivery

With control messages in every packet to provide verification of any packet’s data and its place in the stream, the
data being transmitted can actually arrive in any order, and verify that all has arrived or that some is missing.

Security cookie against SYN flood attack

Since every packet contains verification of its place in the stream, it makes it easy for the protocol to detect when
redundant, corrupted or malicious packets flood the path, and they are automatically dropped when necessary.

Built-in heartbeat (reachability check)

Endpoints automatically send specific control chunks among the other SCTP packet information to peer
endpoints, to determine the reachability of the destination. Hearthbeat acknowledgement packets are returned if
the destination is available.

SCTP Firewall
FortiGate stateful firewalls will protect and inspect SCTP traffic, according to RFC4960. SCTP over IPsec VPN is
also supported. The FortiGate device is inserted as a router between SCTP endpoints. It checks SCTP Syntax for
the following information:

l Source and destination port
l Verification Tag
l Chunk type, chunk flags, chunk length
l Sequence of chunk types
l Associations

The firewall also oversees and maintains several SCTP security mechanisms:

l SCTP four-way handshake
l SCTP heartbeat
l NAT over SCTP
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The firewall has IPS DoS protection against known threats to SCTP traffic, including INIT/ACK flood attacks, and
SCTP fuzzing.
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Troubleshooting

This section offers troubleshooting options for Carrier-related issues.

This section includes:

FortiOS Carrier diagnose commands
This section includes diagnose commands specific to FortiOS Carrier features such as GTP.

GTP related diagnose commands

This CLI command allows you to gain information on GTP packets, logs, statistics, and other information.

diag firewall gtp <command>

apn list <gtp_profile> The APN list entries in the specified GTP profile

auth-ggsns show <gtp_profile> The authorized GGSNs entries for the specified GTP profile. Any GGSNs
not on this list will not be recognized.

auth-sgsns show <gtp_profile> The authorized SGSNs list entries for the specified GTP profile. Any
SGSNs not on this list will not be recognized.

handover-grp show <gtp_
profile>

The handover group showing the range of allowed handover group IP
addresses. The handover group acts like a white list of allowed GTP
addresses with a default deny at the end — if the GTP address is not on
the list, it is denied.

ie-remove-policy list <gtp_
profile>

List of IE policies in the IE removal policy for this GTP profile. The
information displayed includes the message count for this policy, the length
of the SGSN, the list of IEs, and list of SGSN IP addresses.

imsi list <gtp_profile>
IMSI filter entries for this GTP profile. The information displayed includes
the message count for this filter, length of the IMSI, the length of the APN
and IMSI, and of course the IMSI and APN values.

invalid-sgsns-to-long list <gtp_
profile>

List of SGSNs that do not match the filter criteria. These SGSNs will be
logged.

ip-policy list <gtp_profile> List the IP policies including message count for each policy, the action to
take, the source and destination IP addresses or ranges, and masks.

noip-policy <gtp_profile> List the non-IP policies including the message count, which mode, the
action to take, and the start and end protocols to be used by decimal
number.
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path {list | flush}

Select list or flush.

List the GTP related paths in FortiOS Carrier memory.

Flush the GTP related paths from memory.

policy list <gtp_policy> The GTP advanced filter policy information for this GTP profile. The
information displayed for each entry includes a count for messages
matching this filter, a hexidecimal mask of which message types to match,
the associated flags, action to take on a match, APN selection mode,
MSISDN, RAT types, RAI, ULI, and IMEI.

profile list

Displays information about the configured GTP profiles.

You will not be able to see the bulk of the information if you do not log the
output to a file.

runtime-stat flush Select to flush the GTP runtime statistics from memory.

stat

Display the GTP runtime statistics— details on current GTP activity. This
information includes how many tunnels are active, how many GTP profiles
exist, how many IMSI filter entries, how many APN filter entries, advanced
policy filter entries, IE remove policy filter entries, IP policy filter entries,
clashes, and dropped packets.

tunnel {list | flush} Select one of list or flush.

List lists all the GTP tunnels currently active.

Flush clears the list of active GTP tunnels. This does not clear the clash
counter displayed in the stat command.

Applying IPS signatures to IP packets within GTP-U tunnels
GTP-U (GTP user data tunneling) tunnels carry user data packets, signaling messages and error information.
GTP-U uses UDP port 2152. Carrier-enabled FortiGate units can apply IPS intrusion protection and detection to
GTP-U user data sessions.

To apply IPS to GTP-U user data sessions, add an IPS Sensor to a profile and add the profile to a security policy
that accepts GTP-U tunnels. The security policy Service field must be set to GTP or ALL to accept GTP-U
packets.

The Carrier-enabled FortiGate unit intercepts packets with destination port 2152, removes the GTP header and
handles the packets as regular IP packets. Applying an IPS sensor to the IP packets, the Carrier-enabled
FortiGate unit can log attacks and pass or drop packets depending on the configuration of the sensor.

If the packet is GTP-in-GTP, or a nested tunnel, the packets are passed or blocked without being inspected.

To apply an IPS sensor to GTP-U tunnels

1. Go to Security Profiles > Intrusion Protection and select Create New (+) to add an IPS Sensor.
2. Configure the IPS Sensor to detect attacks and log, drop, or pass attack packets.

896 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 7 - FortiOS Carrier Troubleshooting

3. Go to Policy & Objects > IPv4 Policy and apply the IPS sensor to the security policy.
4. Go to Policy & Objects > IPv4 Policy and select Create New to add a security policy or select a security policy.
5. Configure the security policy to accept GTP traffic.

In the security policy configure the source and destination settings to match the GTP traffic. Service to
GTP or ALL so that the security policy accepts GTP traffic.

6. Select the GTP profile within the security policy.
7. Configure any other required security policy settings.
8. Select OK to save the security policy.

GTP packets are not moving along your network
When GTP packets are not getting to their destination, this could be caused by any one of a number of issues.
General troubleshooting principals apply here.

The following sections provide some suggestions on how to troubleshoot this issue:

l Attempt to identify the section of your network with the problem
l Ensure you have an APN configured
l Check the logs and adjust their settings if required
l Check the routing table
l Perform a sniffer trace
l Generate specific packets to test the network

Attempt to identify the section of your network with the problem

The first step is to determine how widespread this problem is. Does it affect the whole GPRS network, or just one
or two devices?

If the entire network is has this problem, the solution is likely a more general one such as ensuring the security
policies allow GTP traffic to pass, the GTP profile specifies SSGNs and GSGNs, or ensuring the GTP general
settings are not overly limiting.

If one part of the network is affected, the problem is more likely centered around configurations with those
network devices specified such as the handover group, or authorized SGSNs/GGSNs. It is also possible that
small portions of the network may have hardware related issues such as cabling or faulty hardware. This section
does not address those issues, and assumes hardware is not the problem.

The handover group is a white list of GTP addresses allowed to handle GTPmessages. If a device’s address is
not on this list, it will be denied.

Ensure you have an APN configured

When you configure your GTP profile, ensure you first configure the APN. Without it, there will be no flow of
traffic. The APN is used in nearly all GTP communications and without it, the Carrier-enabled FortiGate unit
doesn’t have the information it needs.

Check the logs and adjust their settings if required

During normal operation, the log settings will show any problems on the network but may not provide the level of
details required to fully troubleshoot the problem. The reason for this is that the level of detail required for
troubleshooting would quickly overwhelm the daily logs without any real benefit.
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GTP related events in the event log will have message IDs in the range 41216 to 41222. For more information on
GTP log messages, see the Log Message Reference. For more information on logging in general, see the
Logging and Reporting guide.

Once there is a problem to troubleshoot, check the logs to trace the traffic patterns and narrow down the possible
sources of the problem. There may be enough detail for you to locate and fix the problem without changing the
log settings.

Remember to set any changes you made to the log settings back to their original
values when you are done troubleshooting. Otherwise, the amount of detail will
overwhelm your logging.

However, if more detail is required you can change settings such as:

l Lower the Log Frequency number in GTP Profiles so fewer or no log messages are dropped. This will allow a more
accurate picture of everything happening on the network, where you may have had only a partial picture before.

l Ensure all the GTP log events are enabled to provide you with a complete picture.
l Ensure that all relevant event types are enabled under Log & Report > Log Config > Log Settings.

For more information on GTP related logging, see Logging events on the Carrier-enabled FortiGate unit.

General information to look for in the logs includes:

l Are all packets having problems or just certain types?
l Are all devices on the network having problem, or just certain devices?
l Is it just GTP traffic that is having problems or are all types of traffic having the same problem?

Check the routing table

On any network, the routing table determines how packets reach their destination. This is also true on a carrier
network.

If the Carrier-enabled FortiGate unit is running in NAT mode, verify that all desired routes are in the routing table
— local subnets, default routes, specific static routes, and dynamic routing protocols. For complete information,
it is best to check the routing table in the CLI. This method provides more complete information.

If VDOMs are enabled on your Carrier-enabled FortiGate unit, all routing related CLI
commands must be performed within a VDOM and not in the global context.

To check the routing table using the CLI

# get router info routing-table all
Codes: K - kernel, C - connected, S - static, R - RIP, B - BGP
O - OSPF, IA - OSPF inter area
N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2
E1 - OSPF external type 1, E2 - OSPF external type 2
i - IS-IS, L1 - IS-IS level-1, L2 - IS-IS level-2, ia - IS-IS inter area
* - candidate default

S* 0.0.0.0/0 [10/0] via 192.168.183.254, port2
S 1.0.0.0/8 [10/0] via 192.168.183.254, port2
S 2.0.0.0/8 [10/0] via 192.168.183.254, port2
C 10.142.0.0/23 is directly connected, port3
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B 10.160.0.0/23 [20/0] via 10.142.0.74, port3, 2d18h02m
C 192.168.182.0/23 is directly connected, port2

Examining an entry from the routing table above:

B 10.160.0.0/23 [20/0] via 10.142.0.74, port3, 2d18h02m

B BGP. The routing protocol used.

10.160.0.0/23 The destination of this route including netmask.

[20/0] 20 indicates and administrative distance of 20 out of a range of 0 to 255.

0 is an additional metric associated with this route, such as in OSPF

10.142.0.74 The gateway, or next hop.

port3 The interface used by this route.

2d18h02m How old this route is, in this case almost three days old.

Perform a sniffer trace

When troubleshooting network traffic, it helps to look inside the headers of packets to determine if they are
traveling along the route you expect. Packet sniffing can also be called a network tap, packet capture, or logic
analyzing.

If your Carrier-enabled FortiGate unit has NP interfaces that are offloading traffic, this
will change the sniffer trace. Before performing a trace on any NP interfaces, disable
offloading on those interfaces.

What can sniffing packets tell you

If you are running a constant traffic application such as ping, packet sniffing can tell you if the traffic is reaching
the destination, what the port of entry is on the Carrier-enabled FortiGate unit, if the ARP resolution is correct,
and if the traffic is being sent back to the source as expected.

Sniffing packets can also tell you if the Carrier-enabled FortiGate unit is silently dropping packets for reasons
such as RPF (Reverse Path Forwarding), also called Anti Spoofing. This prevents an IP packet from being
forwarded if its source IP address either does not belong to a locally attached subnet (local interface), or be a hop
on the routing between the FortiOS Carrier and another source (static route, RIP, OSPF, BGP). Note that RPF
can be disabled by turning on asymmetric routing in the CLI (config system setting, set
asymmetric enable), however this will disable stateful inspection on the Carrier-enabled FortiGate unit and
consequently cause many features to be turned off.

If you configure virtual IP addresses on your Carrier-enabled FortiGate unit, the unit
will use those addresses in preference to the physical IP addresses. If not configured
properly, secondary IP addresses can cause a broadcast storm. You will notice the
secondary address being preferred when you are sniffing packets because all the
traffic will be using the virtual IP addresses. This is due to the ARP update that is sent
out when the VIP address is configured.
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How to sniff packets

The general form of the internal FortiOS packet sniffer command is:

diag sniffer packet <interface_name> <‘filter’> <verbose> <count>

To stop the sniffer, type CTRL+C.

<interface_name> The name of the interface to sniff, such as port1 or internal. This can also be
any to sniff all interfaces.

<‘filter’>

What to look for in the information the sniffer reads. none indicates no filtering, and
all packets will be displayed as the other arguments indicate.

The filter must be inside single quotes (‘).

<verbose> The level of verbosity as one of:

1 - print header of packets
2 - print header and data from IP of packets
3 - print header and data from Ethernet of packets

<count> The number of packets the sniffer reads before stopping. If you don’t put a number
here, the sniffer will run forever unit you stop it with <CTRL C>.

For a simple sniffing example, enter the CLI command diag sniffer packet port1 none 1 3. This
will display the next 3 packets on the port1 interface using no filtering, and using verbose level 1. At this verbosity
level you can see the source IP and port, the destination IP and port, action (such as ack), and sequence
numbers.

In the output below, port 443 indicates these are HTTPS packets, and 172.20.120.17 is both sending and
receiving traffic.

Head_Office_620b # diag sniffer packet port1 none 1 3
interfaces=[port1]
filters=[none]
0.545306 172.20.120.17.52989 -> 172.20.120.141.443: psh 3177924955 ack 1854307757

0.545963 172.20.120.141.443 -> 172.20.120.17.52989: psh 1854307757 ack 3177925808

0.562409 172.20.120.17.52988 -> 172.20.120.141.443: psh 4225311614 ack 3314279933

Generate specific packets to test the network

If some packets are being delivered as expected while others are not, or after you believe you have fixed the
problem, it is a good idea to generate specific traffic to test your network.

For example if you discover through log messages and packet sniffing that Create PDPContext Request
messages are not being delivered between two SGSNs, you can generate those specific messages on your
network to confirm they are the problem, and later that you have solved the problem and they are now being
delivered as expected.

This step requires a third party traffic generation tool, either hardware or software. This is not be supported by
Fortinet.
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Compliance

This document describes how FortiOS is compliant with Payment Card Industry Data Security Standard (PCI
DSS).

Before you begin
Before you begin using this guide, please ensure that:

l You have administrative access to the web-based manager and/or CLI.
l The FortiGate unit is integrated into your network.
l The operation mode has been configured.
l The system time, DNS settings, administrator password, and network interfaces have been configured.
l Firmware, FortiGuard Antivirus and FortiGuard Antispam updates are completed.
l FortiGuard Analysis &Management Service is properly configured.

While using the instructions in this guide, note that administrators are assumed to be super_admin administrators
unless otherwise specified. Some restrictions will apply to other administrators.

How this guide is organized
This FortiOS Handbook chapter contains the following sections:

Configuring FortiGate units for PCI DSS compliance on page 902 explains the Payment Card Industry Data
Security Standard (PCI DSS). It provides information about configuring your network and FortiGate unit to help
you comply with PCI DSS requirements.

FortiOS 5.4 PCI DSS compliance new features

()
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Configuring FortiGate units for PCI DSS compliance

This chapter provides information about configuring your network and FortiGate unit to help you comply with PCI
DSS requirements. There is also some description of other Fortinet products that can help you with PCI DSS
compliance.

Introduction to PCI DSS
The primary source of information for your PCI DSS compliance program is the Payment Card Industry (PCI) Data
Security Standard itself. Version 3.1 of the standard was published in April 2015. The following is a brief summary
of PCI DSS.

What is PCI DSS?

The Payment Card Industry Data Security Standard (PCI DSS) sets data handling requirements for organizations
that hold, process, or exchange cardholder information.

What is the Cardholder Data Environment

Throughout the PCI DSS requirements, there are references to the Cardholder Data Environment (CDE). The
CDE is the computer environment wherein cardholder data is transferred, processed, or stored, and any networks
or devices directly connected to that environment.

PCI DSS objectives and requirements

PCI DSS consists of 7 control objectives and 12 requirements.

PCI DSS Control Objectives and Requirements

Control Objective Requirement Fortinet Solution

Build and Maintain a Secure
Network and Systems

1. Install and maintain a firewall
configuration to protect cardholder
data

FortiGate firewall functionality.
See Security policies for the CDE
network on page 908

2. Do not use vendor - supplied
defaults for system passwords and
other security parameters

FortiDB vulnerability assessment
and auditing

FortiWeb web application
password checking

See Password complexity and
change requirements on page
914
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Control Objective Requirement Fortinet Solution

Protect Cardholder Data 3. Protect stored cardholder data FortiDB vulnerability assessment
and monitoring

FortiWeb web application firewall

See Protecting stored cardholder
data on page 911

4. Encrypt transmission of
cardholder data across open,
public networks

FortiGate IPsec VPN. See
Protecting communicated
cardholder data on page 911

Maintain a Vulnerability
Management Program

5. Protect all systems against
malware and regularly update
antivirus software or programs

FortiGate integrated AV

FortiClient integrated AV

FortiMobile integrated AV

FortiMail integrated AV

FortiGuard automated AV
updates

See Protecting the CDE network
from viruses on page 912

6. Develop and maintain secure
systems and applications

FortiDB vulnerability assessment,
auditing and monitoring

FortiWeb web application security

FortiGate Application Control

Implement Strong Access
Control Measures

7. Restrict access to cardholder
data by business need-to-know

FortiDB vulnerability assessment,
auditing and monitoring.

See Restricting access to
cardholder data on page 913

8. Identify and authenticate access
to system components

FortiGate integrated database or
hooks to Active Directory. See
Controlling access to the CDE
network on page 914

9. Restrict physical access to
cardholder data

Fortinet professional services in
partnership with partner solutions
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Control Objective Requirement Fortinet Solution

Regularly Monitor and Test
Networks

10. Track and monitor all access to
network resources and cardholder
data

FortiDB auditing and monitoring

FortiAnalyzer event reporting

See Monitoring the network for
vulnerabilities.

11. Regularly test security systems
and processes

FortiDB vulnerability assessment

See Monitoring the network for
vulnerabilities.

Maintain an Information
Security Policy

12. Maintain a policy that
addresses information security for
all personnel

FortiManager security policy
management appliance

This chapter describes how the FortiGate’s features can help your organization to be compliant with PCI DSS.
Requirements that the FortiGate cannot enforce need to be met through organization policies with some means
determined for auditing compliance.

Be sure to read the following wireless guidelines. Even if your organization does not use wireless networking, PCI
DSS requires you to verify periodically that wireless networking has not been introduced into the CDE.

Wireless guidelines

While wired networks usually connect fixed known workstations, wireless networks are more dynamic, introducing
a different set of security concerns.

Even if your organization does not use wireless networking, PCI DSS requires you to verify periodically that
unauthorized wireless networking has not been introduced into the CDE. Wireless networking could be introduced
quite casually by adding a wireless device to a PC on the CDE network.

For all PCI DSS networks, whether they use wireless technology or not, the following requirement applies:

l Test for the presence of wireless access points by using a wireless analyzer at least quarterly or deploying a wireless
IDS/IPS to identify all wireless devices in use. (11.1)

If your organization uses wireless networking outside the CDE network and the firewall prevents communication
with the CDE network, the wireless network is outside the PCI DSS scope, but the firewall configuration must
meet PCI DSS requirements.

If your organization uses wireless networking inside the CDE network, the wireless network is within the PCI DSS
scope. For information about wireless network requirements, see Wireless network security on page 909.

Running PCI DSS compliance checks
FortiOS 5.4 allows you to run a compliance check either on demand or according to a schedule that automatically
checks PCI DSS compliance at the global and/or VDOM level. The compliance check determines whether the
FortiGate is compliant with each PCI DSS requirement by displaying an 'X' next to the non-compliant entries in
the GUI logs.

The FortiGate runs at least 50 compliance checks that report on the status of a number of things including:
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l Checking that out of stet ICMP packets are dropped
l The TCP end timeout is set
l SSH and SSL deep inspection with web filtering drops traffic from servers with invalid server certificates
l Verifying that IPS signatures, Application Control signatures, and Antivirus signatures are up to date
l Determining if Spyware/Malicious sites are being blocked by a web filtering policy
l Verifying that administrators are locked out after 3 login failures

For a complete list of compliance checks go to Log & Report > Compliance Events.

Configuring PCI DSS compliance checking

Go to System > Advanced > Compliance, turn on compliance checking and configure a daily time to run the
compliance check. Or you can select Run Now to run the compliance check on demand.

Go to Log & Report > Compliance Events to view compliance checking log messages that show the results of
running compliance checks.

You can also configure compliance checking and set up the schedule from the CLI:

config system global
set compliance-check {disable| enable}
set compliance-check-time <time>

end

Use the following command to run on-demand compliance checking:

execute dsscc
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Per-VDOM compliance checking

If you have multiple VDOMs enabled compliance checking can be run separately for each VDOM.

Begin from the Global view by going to System > Advanced > Compliance and turning on compliance
checking and configuring a daily time to run the compliance check. This compliance check daily schedule will be
used to run compliance checks on individual VDOMs where compliance checking is enabled them.

You can also enable global compliance checking from the CLI:

config global
config system global

set compliance-check {disable| enable}
set compliance-check-time <time>

end

Then log onto each VDOM for which to enable compliance checking and go to to System > Advanced >
Compliance, and turn on compliance checking . You can also select Run Now to run a compliance check on
that VDOM on demand.

From the CLI edit a VDOM and use the following command to enable compliance checking for that VDOM. The
following example shows how to enable compliance checking for the root VDOM:

config vdom
edit root

config system settings
set compliance-check enable

end

From the CLI you can also log into a VDOM and use the following command to run on-demand compliance
checking:

execute dsscc

From a VDOM GUI go to Log & Report > Compliance Events to view compliance checking log messages that
show the results of running compliance checks.

Compliance checking diagnose command

Use the following command to display diagnostic information about compliance checking:

diagnose debug application dssccd <debug_level>

Network topology
The cardholder data environment must be protected against unauthorized access from the Internet and from
other networks in your organization. FortiGate unit firewall functionality provides tight control over the traffic that
can pass between the following network interfaces:

l Internet
l CDEwired LAN
l CDEwireless LAN
l Other internal networks

The figure below shows how the Cardholder Data Environment can be delineated in a typical network.
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Enterprise network with a cardholder data environment

Internet

The FortiGate unit has at least one network interface connected to the Internet. If your organization uses more
than one Internet service provider, there could be additional network interfaces that function as a route to the
Internet.

The CDE wired LAN

The CDE network typically contains point-of-sale (POS) terminals, databases, and servers. The only security
policies between the CDE network and the Internet should be for encrypted connections. For remote point-of-sale
terminals or off-site databases, VPN connections are required and they should use strong encryption. For a web
server that handles online purchases, only HTTPS (SSL or TLS) connections can be permitted. The security
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policies that enable these connections should have the narrowest possible definitions for source address,
destination address and service.

PCI DSS does not require the CDE network to be isolated from the rest of your corporate LAN. But isolating the
CDE network reduces the scope of required data protection measures and may reduce the scope of PCI DSS
assessments that are periodically required.

The CDE wireless LAN

Wireless networking is a special issue. Even if you do not use wireless technology you must monitor to ensure
that unauthorized wireless access has not been added to the CDE network. For this purpose, the figure above
shows a FortiAP device in the CDE. The FortiAP device can provide dedicated wireless monitoring, an access
point, or both.

A small retail outlet could reduce costs by using a FortiWiFi unit, a FortiGate unit with integrated wireless
networking. The FortiWiFi unit would have to be located where it could provide sufficient wireless monitoring (or
access point) coverage for the entire premises.

Other internal networks

Other internal networks such as your office LAN, unless they provide connection to the CDE, are not subject to
PCI DSS requirements.

Security policies for the CDE network
The FortiGate unit’s firewall functionality is ideally suited to PCI DSS requirement 1.2.1, “Restrict inbound and
outbound traffic to that which is necessary for the cardholder data environment, and specifically deny all other
traffic.” Security policies control the source, destination, and type of traffic passing between networks.

The PCI DSS standard includes requirements to document your network topology and configuration. As part of
that requirement, and to assist the auditing of your network, make use of the Comment field available in
FortiGate security policies. Describe the purpose of each policy.

Controlling the source and destination of traffic

The source and destination are the first parameters you specify in a security policy. (Go to Policy & Objects >
IPv4 Policy and select Create New.)

The Interface settings depend on network topology. The Source and Destination Addresssettings define the
IP addresses to which the policy applies. These should be as narrow as possible, so that only the appropriate
hosts are included. For example, if the destination is a server with a single IP address, the named Destination
Address should be defined as that single address, not the entire subnet on which the server resides.
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Addresses are defined in Policy & Objects > Addresses. Some addresses will be used in several security
policies, so it is best to plan ahead and define the addresses first.

Controlling the types of traffic in the CDE

The Policy & Objects > Service setting determines which types of traffic can pass based on protocol.

You can select a single protocol from the Service drop-down list. To add another protocol, select the green “+”
button to access the Service drop-down list again. If several security policies will need the same list of services,
consider creating a named service group. (Go to Firewall Objects > Service > Groups.) In the security policy,
service groups are available at the bottom of the Service drop-down list.

The default deny policy

All traffic not specifically allowed by a security policy that you create is blocked by the Implicit policy listed at the
bottom of the Policy & Objects > IPv4 Policy page.

You cannot delete this policy and you can edit the policy only to enable or disable logging of the traffic that it
handles.

Wireless network security
Scanning for rogue access points is the minimum requirement for wireless security. Even if your organization
does not use wireless networking, PCI DSS requires you to verify periodically that wireless networking has not
been introduced into the CDE.

If you use wireless networking, the wireless network is only within the PCI DSS scope if it can connect to the CDE.

On-wire detection of rogue APs

FortiGate units include an “on-wire” detection technique that correlates the SSID MAC addresses of the unknown
access points with MAC addresses detected on your wired networks. This helps to differentiate unrelated
neighboring APs from security-compromising unauthorized APs connected to your network.

Setting up rogue access point scanning

A FortiGate unit with a connected FortiAP unit can perform wireless scanning. Each of the FortiAP radios can act
as a dedicated monitor or can perform scanning in the background while acting as a wireless access point.

Radio 1 operates in the 2.4GHz band and Radio 2 operates in the 5GHz band. Both bands should be monitored.
The FortiAP unit(s) used for scanning must be located within the coverage area that would result if an access
point were added to the CDE.

To configure rogue AP scanning in a FortiAP profile

1. Go toWiFi & Switch Controller > WIDS Profiles.
On some models, the menu isWiFi & Switch Controller.

2. Select an existing WIDS profile and edit it, or select Create New.
3. Make sure that Enable Rogue AP Detection is selected.
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4. Select Enable On-Wire Rogue AP Detection.
5. Optionally, enable Auto Suppress Rogue APs in Foreground Scan.
6. Select OK.

Viewing the results of rogue AP scanning

Go toMonitor > Rogue AP Monitor to view information about detected rogue wireless access points.

Logging the results of rogue AP scanning

To ensure that detection of rogue access points is logged, go to Log & Report > Log Settings, enable Event
Logging and selectWiFi activity event.

Securing a CDE network wireless access point

If your wireless network is within PCI DSS scope, it must meet the following requirements:

l Default settings such as SSID and passphrases must be changed.
l Use WPA/WPA2 security.
l Log wireless activity.

Setting wireless security

On FortiGate units, go toWiFi & Switch Controller > SSID to configure wireless security settings for either a
new or existing virtual access point.

The default SSID for the FortiAP is “fortinet”. You must change this.

The Security Modemust be set to one of the WPA2 modes. Both WPA or WPA2 clients can be served. In the
CLI, you can optionally select exclusively WPA or WPA2 operation.

WPA/WPA2-Enterprise Authentication uses separate logon credentials for each user. Either FortiGate user
group security or an external RADIUS server performs the authentication. Optionally, certificate-based security
can also be applied. WPA/WPA2-Personal authentication requires a single pre-shared key that is used by all
clients and is thus less secure.

For detailed information about wireless access points, see the Deploying Wireless Networks chapter of the
FortiOS Handbook.
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Logging wireless network activity

To ensure that wireless network actiity is logged, go to Log & Report > Log Settings, enable Event Logging
and selectWiFi activity event.

Protecting stored cardholder data
The Fortinet FortiDB and FortiWeb products can provide security for your sensitive cardholder data.

The Fortinet Database Security (FortiDB) device provides vulnerability assessment, database activity monitoring,
auditing and monitoring.

The Fortinet FortiWeb Web Application Firewall deployed in front of public-facing web applications protects Web
applications, databases, and the information exchanged between them. In particular, it addresses the PCI DSS
requirements 6.5 and 6.6 regarding web application vulnerabilities such as cross-site scripting, SQL injection, and
information leakage.

FortiGates support some web application firewall security features and allow you to offload selected HTTP and
HTTPS traffic to an external FortiWeb device. To offload HTTP traffic to go Security Fabric > Settings, enable
HTTP service and select FortiWeb.

Protecting communicated cardholder data
If cardholder data must be communicated over an untrusted network, such as the Internet, use the FortiGate
unit’s IPsec VPN capability to exchange the data securely. If you support customer online transactions, use
HTTPS (SSL or TLS encryption) for security. The relevant PCI DSS requirement is:

l Use strong cryptography and security protocols (for example, SSL/TLS, IPSEC, SSH, etc.) to safeguard sensitive
cardholder data during transmission over open, public networks. (4.1)

This does not prescribe particular cryptography, but it can be interpreted as a requirement to follow industry best
practices.

Configuring IPsec VPN security

The security considerations for IPsec VPNs are encryption and authentication.

Encryption

Go to VPN > IPsec Tunnels to configure an IPsec VPN. In both Phase 1 and Phase 2 parts of the configuration,
you select the encryption to use.

These are advanced settings, overriding defaults that are not necessarily the strongest algorithms. VPNs
negotiate over standards, so you can list multiple proposed algorithms. The VPN will use the strongest encryption
that both ends support.
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Choose strong encryption. The available encryption algorithms in descending order of strength are AES256,
AES192, AES128, 3DES, DES. DES encryption is the weakest with only a 64-bit key and does not meet the 80-bit
key length minimum that PCI DSS requires.

The message digest (authentication) algorithms in descending order of strength are SHA512, SHA384, SHA256,
SHA1 and MD5. MD5 is particularly weak and should be avoided.

Authentication

VPN peers authenticate each other before establishing a tunnel. FortiGate units support two different
authentication methods: pre-shared key and RSA signature (certificate). Certificates provide the best security.
PCI DSS does not prohibit pre-shared keys, but you should limit access to the keys to the personnel who are
responsible for the FortiGate units or other equipment at either end of the VPN.

Configuring SSL VPN security

The SSL VPN configuration includes a choice of encryption algorithm. You can only configure encryption key
algorithms for SSL VPN in the CLI:

config vpn ssl settings
set algorithm {low | medium | high}

end

The default option of Medium at RC4 (128 bits) is acceptable, but the High option, AES (128/256 bits) and 3DES
is more secure. The Low option, RC4 (64 bits), DES and higher does not meet PCI DSS requirements.

Protecting the CDE network from viruses
PCI DSS requires the use of regularly updated antivirus protection. The antivirus functionality of the FortiGate
unit protects both the FortiGate unit and the networks it manages. Workstations on these networks can be
protected using FortiClient Endpoint Security. Both FortiGate and FortiClient antivirus protection can receive
updates from Fortinet’s FortiGuard service. Workstations can also use third-party antivirus applications with
update services.

The FortiGate unit can enforce the use of antivirus software, denying unprotected workstations access to the
network.

Enabling FortiGate antivirus protection

The antivirus profile must apply AV scanning to all protocols. You also need to enable SSL inspection to include
secure protocols in antivirus scanning. The extended AV database contains the largest number of virus
signatures.

To enable SSL inspection

1. Go to Security Profiles > SSL/SSH Inspection.
2. Set Inspection Method to Full SSL Inspection.
3. Set each listed protocol toOn and then select Apply.

To select the extended antivirus database

The antivirus database is selectable using the CLI:

config antivirus settings
set default-db extended
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end

For detailed information about the Antivirus feature, see the Security Profiles chapter of the FortiOS Handbook.

Configuring antivirus updates

On the dashboard, check the License Information widget. The Support Contract section should indicate that
the FortiGate is registered and show future expiry dates for the FortiGuard Antivirus license. If your FortiGate unit
is not registered, you can register it from the License Information widget.

In the FortiGuard Services section, check the Antivirus field. If the service is unreachable, see the online Help
for information about troubleshooting your connectivity to FortiGuard Services.

Enforcing firewall use on endpoint PCs

PCI DSS requires you to “install personal firewall software on any mobile and/or employee-owned devices that
connect to the Internet when outside the network (for example, laptops used by employees), and which are also
used to access the network. (1.4)” Consider using the Endpoint Control feature of the FortiGate unit to enforce
use of this software.

Monitoring the network for vulnerabilities
There are several tools that can assist you in monitoring your network for vulnerabilities and provide evidence to
the PCI DSS auditor of such monitoring.

FortiGate logs

FortiGate units can be configured to send logs to FortiAnalyzer unit. In a larger network, this enables you to
collect log information in a central location from several FortiGate units. You can also send logs to FortiCloud and
to multiple syslog servers.

Monitoring with other Fortinet products

In addition to your FortiGate unit and its FortiOS firmware, there are several other Fortinet products that can
assist your organization to comply with PCI DSS requirements.

Fortinet Database Security (FortiDB)

A FortiDB appliance or FortiDB software can provide vulnerability scanning and activity monitoring for your
databases. For more information about this product, see the Fortinet website, www.fortinet.com.

FortiWeb Web Application Security

If your organization engages in e-Commerce, you can use FortiWeb Application Security to protect your web
servers against attack. The FortiWeb application protects against HTTP and XML-based attacks, guards against
attempts to deface your websites, and scans web servers for vulnerabilities. For more information about this
product, see the Fortinet website, www.fortinet.com.

Restricting access to cardholder data
In addition to security policies and authentication governing access to the CDE, you can deploy the Fortinet
Database Security (FortiDB) device, which provides vulnerability assessment, database activity monitoring,
auditing and monitoring. You can also deploy FortiAuthenticator to increase authentication options.
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Controlling access to the CDE network
PCI DSS requires each user to be uniquely identified and authenticated. On the FortiGate unit, this applies to
administrators and to users of SSL VPN and IPsec VPNs.

Password complexity and change requirements

By default, the FortiGate unit admin account has no password. Be sure to define a password.

PCI DSS password requirements are:

l Require a minimum length of at least seven characters. (8.2.3)
l Contain both numeric and alphabetic characters. (8.2.3)
l Change user passwords/passphrases at least every 90 days. (8.2.4)

To facilitate creation of compliant administrator passwords, you can set a password policy. Go to System
> Settings Select Enable Password Policy, enter the following and then select Apply.

The password policy does not apply to user passwords. Both password complexity and
password expiry for users would need to addressed by making them a policy in your
organization.

Minimum Length 8 or more. (Field does not accept a value less than 8.)

Must Contain

At minimum, set a required number of Numerical Digits and either
Upper Case Letters or Lower Case Letters.

Also setting a required number of Non-alphabetic Letters is acceptable.

Apply Password Policy to Select Administrator Password.

Enable Password
Expiration Set to 90 days or less. The default is 90 days.

Password non-reuse requirement

PCI DSS requires that passwords are not re-used to satisfy the change requirement:
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l Do not allow an individual to submit a new password/phrase that is the same as any of the last four
passwords/phrases he or she has used. (8.2.5)

FortiGate users don’t set their own passwords. The super_admin administrators can and so can admins with
appropriate access. There is, however, no FortiGate-based mechanism to limit re-use of passwords.

Administrator lockout requirement

PCI DSS requires a user account lockout for administrators to guard against unauthorized access attempts:

l Limit repeated access attempts by locking out the administrator after not more than six attempts. (8.1.6),
l Set the lockout duration to a minimum of 30 minutes or until an administrator enables the user ID. (8.1.7)

You can meet these requirements with the following CLI commands:

config system global
set admin-lockout-threshold 6
set admin-lockout-duration 1800

end

The threshold can be less than 6 and the lockout duration can be more than 1800.

Administrator timeout requirement

PCI DSS requires:

l If a session has been idle for more than 15 minutes, require the user to re-authenticate to re-activate the terminal or
session. (8.1.8)

By default, the idle timeout is five minutes. You can go to System > Settings and change the Idle Timeout
timeout to any value up to the permitted value of 15 minutes.

Administrator access security

To accommodate the requirement for unique identification of each user, the generic admin account should either
be assigned to only one administrator or not used at all. You can create an administrator account for each
administrator in System > Administrators.

You can also rename the admin administrator account to something that attackers are less likely to guess. To
rename the admin administrator account you must go to System > Administrators and create a new
administration account with the super_admin administrator profile and then login with this new account and
change the name of the admin administrator account.

If an administrator always works from the same workstation, consider using the Trusted Host feature. The
administrator will be able to log in only from a trusted IP address. You can define up to three trusted IP addresses
per administrator.

Administrative access must also be enabled per network interface. Go to Network > Interfaces to edit the
interface settings. Enable administrative access only on interfaces where you would expect the administrator to
connect. Allow only secure connection protocols, HTTPS for web-based access, SSH for CLI access.

Remote access security

For remote access, PCI DSS requires two-factor authentication: a password and some other authentication, such
as a smart token or certificate. This applies to employees, administrators, and third parties.

For remote access from the Internet, if possible you should also use the trusted hosts feature to limit the source
addresses from which administrators can log into the FortiGate.
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SSL VPN users

For SSL VPN users, implement two-factor authentication by requiring users to have a certificate in addition to the
correct password. Go to VPN > SSL-VPN Settings, enable Require Client Certificate.

IPsec VPN users

If remote Users access your network using an IPsec VPN, you can implement two-factor authentication by adding
a user group to a Remote Access IPSec VPN tunnel that requires two-factor authentication with FortiToken. This
adds extended authentication (XAUTH) to the VPN and requires the user to use two-factor authentication in
addition to the VPN authentication provided by the certificate or pre-shared key. As PCI DSS requires each user to
have a unique identifier, you should already have user accounts and user groups defined.
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Chapter 9 - Firewall

Firewall

Welcome and thank you for selecting Fortinet products for your network protection. This document is intended to
provide the concepts and techniques that will be needed to configure the FortiGate firewall on your FortiGate
unit.

Before you start administrating your FortiGate device, certain assumptions have been made in the writing of this
manual:

l You have administrative access to the Web based GUI or to the Command Line Interface.
l The FortiGate unit is integrated into your network.
l The operation mode (NAT or Transparent) has been configured.
l Network Interfaces have been configured.
l DNS settings have been configured.
l The system time settings have been configured.
l Firmware is up to date.
l FortiGuard Service licences are current and the device is able to connect to the FortiGuard Servers.
l If you are using FortiCloud, it is properly configured.

How this Guide is Organized
This guide contains a number of different topic that, at its simplest, can be grouped into fundamental firewall
topics such as policies, objects and network defense and topics that have to do with the optimization of the
firewall such asWAN optimization, proxies and caching.

Fundamentals

"Firewall concepts" on page 940 explains the ideas behind the components, techniques and processes that are
involved in setting up and running a firewall in general and the FortiGate firewall in particular. The premise here is
that regardless of how experienced someone is with firewalls as they go through the process of configuring a
firewall that is new to them they are likely to come across a term or setting that they may not be familiar with even
if it is only in the context of the setting they are working in at the moment. FortiGate firewall are quite
comprehensive and can be very granular in the functions that they perform, so it makes sense to have a
consistent frame of reference for the ideas that we will be working with.

Some examples of the concepts that will be addressed here are:

l "What is a Firewall?"
l "NAT"
l "IPv6"

"Firewall objects" describes the following firewall objects:

l Addressing
l Services
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l Firewall Policies

"Network defense" on page 1025 describes various methods of defending your Network using the abilities of the
FortiGate Firewall.

"Object Configuration" on page 1063 is similar to a cookbook in that it will refer to a number of common tasks
that you will likely perform to get the full functionality out of your FortiGate firewall. Because of the way that
firewall are designed, performing many of the tasks requires that firewall components be set up in a number of
different sections of the interface and be configured to work together to achieve the desired result. This section
will bring those components all together as a straight forward series of instructions.

FortiGate Firewall Components

The FortiGate firewall is made up of a number of different components that are used to build an impressive list of
features that have flexibility of scope and granularity of control that provide protection that is beyond that
provided by the basic firewalls of the past.

Some of the components that FortiOS uses to build features are:

l Interfaces
l VLANs
l Soft Switches
l Zones
l Predefined Addresses
l IP address based
l FQDN based
l Geography based
l Access Schedules
l Authentication
l Local User based
l Authentication Server based (Active Directory, Radius, LDAP)
l Device Based
l Configureable Services
l IPv4 and IPv6 protocol support

The features of FortiOS include but are not limited to:

l Security profiles, sometimes referred to as Unified Threat Management (UTM) or Next Generation Firewall
(NGFW)

l Predefined firewall addresses (this includes IPv4 and IPv6, IP pools,. wildcard addresses and netmasks, and
geography-based addresses)

l Monitoring traffic
l Traffic shaping and per-IP traffic shaping (advanced)
l Firewall schedules
l Services (such as AOL, DHCP and FTP)
l Logging traffic
l Quality of Service (QoS)
l Identity-based policies
l Endpoint security
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Firewall Optimization

There are a few different methodologies of optimization and most of these methodologies has been divided into:

l Concepts section - This will have the basic ideas behind the how and why of the topic. Because the number of
topics is larger, the ideas are not as pervasive and the content is not so extensive as in the Fundamental section,
some of the topics will include instructions on the configuration for that individual topic in order to keep the
information fo granular topics together.

l Configuration section- Just like the Configuration section of the Fundamentals, this will be a cookbook style of
documentation showing how to configure something that achieves a specific functionality from the FortiGate.

The optimization topics include:

l Secure Web Gateway, WAN Optimization, Web Caching and WCCP
l Example topologies relevant to WAN Optimization
l Inside FortiOS: WAN Optimization
l WANOptimization Concepts
l WANOptimization Configuration
l Peers and authentication groups
l Web Cache Concepts
l Web Cache Configuration
l WCCPConcepts
l WCCPConfiguration
l Web Proxy Concepts
l Web Proxy Configuration
l Explicit Proxy Concepts
l Explicit Proxy Configuration
l Transparent Proxy Concepts
l Transparent Proxy Configuration
l FTP Proxy Concepts
l FTP Proxy Configuration
l Diagnose commands for WAN Optimization

How does a FortiGate Protect Your Network?
The FortiGate firewall protects your network by taking the various components and using them together to build a
kind of wall or access control point so that anyone that is not supposed to be on your network is prevented from
accessing your network in anyway other than those approved by you. It also protects your network from itself by
keeping things that shouldn’t happen from happening and optimizing the flow of traffic so that the network is
protected from traffic congestion that would otherwise impede traffic flow.

Most people have at one time or another played with the children’s toy system that is made up of interlocking
blocks. The blocks come in different shapes and sizes so that you can build structures to suit your needs and in
your way. The components of the FortiGate firewall are similar. You are not forced to use all of the blocks all of
the time. You mix and match them to get the results that you are looking for. You can build a very basic structure
that’s only function is to direct traffic in and out to the correct subnets or you can build a fortress that only allows
specific traffic to specific hosts from specific hosts at specific times of day and that is only if they provide the
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credentials that have been pre-approved and all of the traffic is encrypted so that even when the traffic is out on
the Internet it is private from the world. Just like the interlocking blocks, what you build is up to you, but chances
are if you put them together the right way there isn’t much that can’t be built.

Here is one example of how the components could be put together to support the requirements of a network
infrastructure design.

l Off the Internal interface you could have separate VLANs. One for each for the departments of Sales, Marketing
and Engineering so that the traffic from the users on one VLAN does not intrude upon the hosts of the other VLANs
and the department are isolated from one another for security reasons.

l To ease in the administration each of the VLAN sub-interfaces is made a member of a zone so that security policies
that apply to all of the hosts on all of the VLANs can be applied to all of them at once.

l Using the addresses component each of the IP address ranges could be assigned a user friendly name so that they
could be referred to individually and then for policies that would refer to them all as a whole the individual ranges to
be made members of an address group.

l Firewall schedules could be created to address the differing needs of each of the groups so that Sales and
Marketing could be allowed access to the Internet during regular business hours and the Engineering department
could be allowed access during the lunch break.

l By setting up the outgoing policies to use FortiGuard Web-filtering the employees could be prevented from visiting
inappropriate sites and thus enforcing the policies of the HR department.

l A couple of virtual IP addresses with port forwarding could be configured to allow users on the Internet to access a
web server on the DMZ subnet using the company’s only Public IP address without affecting the traffic that goes to
the company’s mail server that is hosted on a complete different computer.

l Even though the Web server on the same DMZ has an FTP service to allow for the uploading of web pages to the
web server from the Marketing and Engineer teams, by placing a DENY policy on any FTP traffic from the Internet
malicious users are prevented from abusing the FTP service.

l Bymonitoring the traffic as it goes through the policies you can verify that the policies are in working order.
l By using a combination of ALLOW and DENY policies and placing them in the correct order you could arrange for an

outside contractor to be allowed to update the web site as well

These set of configurations is not extensive but it does give an idea of how different components can be mixed
and matched to build a configuration that meets an organization’s needs but at the same time protect it from
security risks.

What's new for Firewall in 5.6

New Firewall Features in 5.6.4
The following list contains new firewall features added in FortiOS 5.6.4. Click on a link to navigate to that section
for further information.

l Using a FortiCache as a cache service on page 1174

Using a FortiCache as a cache service

Some FortiGate devices don't have sufficient memory or disk space to run a cache service. This feature allows a
FortiGate to connect to a FortiCache that has a higher cache capability than most FortiGates.
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New Firewall Features in 5.6.3

Multi-port support for Explicit Proxy (402775)

Support has been added for the use of multiple ports and port range in the explicit FTP or Web proxies.These
changes have been added in both CLI and GUI.

CLI changes:

set http-incoming-port <port_low>[-<port_high>]

Where:

l port_low - the low value of the port
l port_high - the high value of the port

The port_high value can be omitted if port_low and port_high are the same.

Nturbo support CAPWAP traffic and fix IPsec IPv6 firewall policy code typo (290708) (423323)

NTurbo is used for IPSEC+IPS case. The IPSEC SA info is passed to NTURBO as part of VTAG for control packet
and will be used for the xmit.

If the packets need to go through IPSEC interface, the traffic will be always offloaded
to Nturbo. But for the case that SA has not been installed to NP6 because of hardware
limitation or SA offload disable, the packets will be sent out through raw socket by IPS
instead of Nturbo, since the software encryption is needed in this case.

CLI Changes:

Previously, NTurbo could only be enabled or disabled globally. The setting of np-acceleration has been added to
the firewall policy context instead of just the global context.

Add: Added a CLI command in the firewall policy to enable/disable NTurbo acceleration.

config firewall policy
edit 1

set np-accelation [enable|disable]
end

When IPS is enabled for VPN IPsec traffic, the data can be accelerated by NTurbo now.

Toggling SNAT in Central SNAT policies (434981)

The central NAT feature in not enabled by default. When central-nat is enabled, nat option under IPv4
policies is skipped and SNAT must be done via central-snat-map.

l Info messages and redirection links have been added to IPv4 policy list and dialog to indicate the above
l If NGFWmode is policy-based, then it is assumed that central-nat (specifically SNAT) is enabled implicitly
l The option to toggle NAT in central-snat-map policies has been added (previously it was only shown in NGFW

policy-based mode).
l In central-snat policy dialog, the port-mapping fields for the original port have been updated to accept ranges.
l Nat will be skipped in firewall policy if per vdom central nat is enabled.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

921



What's new for Firewall in 5.6 Chapter 9 - Firewall

Example scenarios to show changes in how CLI treats central-nat

Change: make nat available regardless of NGFW mode.

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897
set nat enable
end

Change: hide nat-port if nat-ippool is not set or NAT is disabled.

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897
set nat disable
end

Change:change orig-port to accept range

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897 (help text changed to: Original port or port range).
set nat-port 35804-35805
end

Improved wildcard support for firewall fqdn (444646)

The following wildcard character instances are now supported in wildcard FQDN addresses:

l "?" character
l "*" character in the middle of a phrase
l The "?*" combination

Policy Matching based on Referrer Headers and Query Strings (446257)

Web proxy policies support creating web proxy addresses to match referrer headers and query strings.
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Matching referrer headers

For example, to create a web proxy address to match the referrer header to block access to the following
YouTube URL http://youtube.com/user/test321. The http request will have the following format:

GET /user/test321 HTTP/1.1
Host: www.youtube.com
User-Agent: curl/7.52.1
Accept: */*

Create the following web proxy addresses to match this page:

config firewall proxy-address
edit youtube

set type host-regex
set host-regex ".*youtube.com"

next
edit test321

set host "youtube"
set path "/user/test321"
set referrer enable

end

Then create two proxy policies, one that allows access to all traffic and a second one that blocks access to the
page that matches the referrer header:

config firewall proxy-policy
edit 1

set uuid 92273e4e-8c53-51e7-a7bd-f26e6e15fc98
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "all"
set service "webproxy-connect"
set action accept
set schedule "always"
set utm-status enable
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
edit 2

set uuid d35ad06a-8c53-51e7-8511-17200f682a4a
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "test321"
set service "webproxy"
set action accept
set schedule "always"
set utm-status enable
set av-profile "default"
set profile-protocol-options "test"
set ssl-ssh-profile "test"

end
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Matching query strings

To match the video with URL youtube.com/watch?v=XXXXXXXXX, (where XXXXXXXXX is an example YouTube
query string) you need to match an HTTP request with the following format:

GET /user/watch?v=GLCHldlwQsg HTTP/1.1
Host: www.youtube.com
User-Agent: curl/7.52.1
Accept: */*

Create the following web proxy addresses to match this video or query string:

config firewall proxy-address
edit "youtube"

set uuid 4ad63880-971e-51e7-7b2e-c69423ac6314
set type host-regex
set host-regex ".*youtube.com"

next
edit "query-string"

set uuid 7687a8c0-9727-51e7-5063-05edda03abbf
set host "youtube"
set path "/watch"
set query "v=XXXXXXXXX"

end

Then create two proxy policies, one that allows access to all traffic and a second one that blocks access to the
page that matches the query string

config firewall proxy-policy
edit 1
set uuid 92273e4e-8c53-51e7-a7bd-f26e6e15fc98

set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "all"
set service "webproxy-connect"
set action accept
set schedule "always"
set utm-status enable
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
edit 2

set uuid d35ad06a-8c53-51e7-8511-17200f682a4a
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "query-string"
set service "webproxy"
set action accept
set schedule "always"
set utm-status enable
set av-profile "default"
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
end
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New Firewall Features in 5.6.1

Improvement to NAT column in Policy List Display (305575)

The NAT column in the listing of Policy can provide more information than before.

Previously the field for the policy in the column only showed whether NAT wasEnabled orDisabled.

With the new improvements, not only does the field show the name of the Dynamic Pool, if one is being used, but
the tool-tip feature is engaged if you hover the cursor over the icon in the field and provides even more specific
information.

GUI support for adding Internet-services to proxy-policies (405509)

There is now GUI support for the configuration of adding Internet services to proxy policies. When choosing a
destination address for a Proxy Policy, the Internet Service tab is visible and the listed objects can be selected.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

925



What's new for Firewall in 5.6 Chapter 9 - Firewall

By choosing an Internet Service object as the Destination, this sets internet-service to enable and
specifying either an Address or IPv6 Address object will set internet-service to disable.

Inline editing of profile groups on policy (409485)

There can now be editing to the profile groups within the policy list display window. Before, you had to go into the
edit window of the policy, such as in the image below:

However, now the editing can be done from the list display of policies and clicking on the GRP icon. Right clicking
on the icon will slide a window out from the left and left clicking will give you a drop-down menu.
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Rename "action" to "nat" in firewall.central-snat-map (412427)

The action field option in thecontext of firewall central-snat-map in the CLI was considered by some
to be a little ambiguous, so it has been renamed to nat, an option that can either be enabled or disabled.

Explicit proxy supports session-based Kerberos authentication (0437054)

l Explicit proxy supports session-based Kerberos authentication
l Transparent proxy will create an anonymous user if the an attempt to create a NTLM connection fails.
l When FSSO authentication fails for the explicit FTP proxy, the FortiGate responses with the error message "match

policy failed".

New Firewall Features in 5.6.0

Optimization of the firewall Service cache (355819)

In order to improve the efficiency and performance of the firewall Service cache, the following improvements
have been made:

l The logic behind the structure of the cache has been simplified. Instead of storing ranges of port numbers, we store
each individual port number in the cache

l Separate caches are created for each VDOM so that cache searches are faster.
l The performance of more frequently used cases has been increased
l Hash tables are used to improve the performance of complex cases. These could include such instances as:

l service names tied to specific IP Ranges
l redefinition (one port number with multiple service names)

New CLI option to prevent packet order problems for sessions offloaded to NP4 or NP6
(365497)

In order to prevent the issue of a packet, on FortiGate processing a heavy load of traffic, from being processed
out of order, a new setting has been added to better control the timing of pushing the packets being sent to NP
units.

The new option, delay-tcp-npc-session, has been added into the context of config firewall policy within the CLI

config firewall policy
edit <Integer for policy ID>

set delay-tcp-npc-session
end

Policy may not be available on units not using NP units.

GUI changes to Central NAT (371516)

The Central NAT configuration interface prevents the accidental occurrence of being able to select “all” and
“none” as two objects for the same field. It only allows the selecting of a single IP pool, though it is still possible to
select multiple IP pools within the CLI.
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Max value for Firewall User authentication changed (378085)

Previously, the maximum time that a member of a firewall user group could remain authenticated without any
activity was 24 hours (1440 minutes). The maximum value for this setting has been changed to 72 hours (4320
minutes). This allow someone to log in but not be kicked off the system due to inactivity over the course of a
weekend.

The syntax in the CLI for configuring this setting is:

config user group
edit <name of user group>

set authtimeout 4320
end

Changes to default SSL inspection configuration (380736)

SSL is such a big part of normal traffic that SSL certificate inspection is no longer disabled by default. SSL
inspection is now mandatory in firewall policies whenever a policy includes a security profile. The default setting is
the Certificate Inspection level. As a result there have been a few changes within the CLI and the GUI.

CLI

The setting SSL-SSH-Profile, is a required option, with the default value being “certificate-inspection”, when it is
applicable in the following tables:

l firewall.profile-group
l firewall.policy
l firewall.policy6,
l firewall.proxy-policy

The following default profiles are read-only:

l certificate-inspection
l deep-ssl-inspection

GUI

IPv4/IPv6 Policy and Explicit Proxy Policy edit window

l The configuration and display set up for SSL/SSH Inspection is now similar to "profile-protocol-option" option
l The disable/enable toggle button is no longer available for the Profile Protocol Option
l The default profile is set to "certificate-inspection"

IPv4/IPv6 Policy, Explicit Proxy Policy list page

l There is validation for SSL-SSH-Profile when configuring UTM profiles

SSL/SSH Inspection list page

l There is no delete menu on GUI for default ssl profiles
l The "Edit" menu has been changed to "View" for default SSL profiles
l The default SSL profile entries are considered an implicit class and are grayed out

SSL/SSH Inspection edit window
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l The only input for default SSL profiles is now download/view trusted certificate links
l To return to the List page from default SSL profiles, the name of the button is now "Return"

Profile Group edit window

l There is no check box for SSL-SSH-Profile. It is always required.

Name change conventions due to upgrade

Starting in 5.6, the profiles "certificate-inspection" and "deep-inspection" are set up by the firmware as default
read-only profiles. If you have profiles with these names that were configured in a previous version of FortiOS,
rather than overwrite the firmware's default profile, profiles with these names will be upgraded to reflect the
configuration conventions of the new firmware but the profile names will be changed by adding a prefix of "_upg_
".

Add firewall policy comment field content to log messages (387865)

There has been a need by some customer to have some information in the logs that includes specific information
about the traffic that produced the log. The rather elegant solution is that when the log-policy-comment option is
enabled, the comment field from the policy will be included in the log. In order to make the logs more useful
regarding the traffic just include a customized comment in the policy and enable this setting.

Syntax

config system settings
set log-policy-comment [enable | disable]
end

l This setting is for all traffic and security logs.
l It can be select on a per VDOM basis

Learning mode changes profile type to single (387999)

The Learning mode does not function properly when it is applied to a policy that has a UTM profile group applied
to it. The logging that should be taking place from the Learning Mode profiles does not occur as intended, and the

Automatically switching the profile type to single on a policy with Learning mode enabled prevents it from being
affected by the UTM policy groups.

MAC address authentication in firewall policies and captive portals (391739)

When enabled, a MAC authentication request will be sent to fnbamd on any traffic. If the authentication receives
a positive response, login becomes available. If the response is negative the normal authentication process takes
over.

CLI

New option in the firewall policy setting

config firewall policy
edit <policy ID>

set radius-mac-auth-bypass [enable |disable]
end

New option in the interface setting
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config system interface
edit <interface>

set security-mode captive-portal
set security-mac-auth-bypass
end

Display resolved IP addresses for FQDN in policy list (393927)

If a FQDN address object is used in a policy, hovering the cursor over the icon for that object will show a tool tip
that lists the parameters of the address object. This tool tip now includes the IP address that the FQDN resolves
to.

Added comment for acl-policy, interface-policy and DoS-policy (396569)

A comment field has been added to the following policy types:

l acl-policy

l interface-policy

l DoS-policy

Comments of up to 1023 characters can be added through the CLI.

Examples:

DoS policy

config firewall DoS-policy
edit 1

set comment "you can put a comment here(Max 1023)."
set interface "internal"
set srcaddr "all"
set dstaddr "all"
set service "ALL"
config anomaly

edit "tcp_syn_flood"
set threshold 2000
next

end
end

Interface policy

config firewall interface-policy
edit 1

set comment "you can put a comment here(max 1023)."
set interface "dmz2"
set srcaddr "all"
set dstaddr "all"
set service "ALL"
end

Firewall ACL

config firewall acl
edit 1

set status disable
set comment "you can put a comment here(max 1023)."
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set interface "port5"
set srcaddr "all"
set dstaddr "all"
set service "ALL"

end

Internet service settings moved to more logical place in CLI (397029)

The following settings have moved from the application context of the CLI to the firewall context:

l internet-service

l internet-service-custom

Example of internet-service

config firewall internet-service 1245324
set name "Fortinet-FortiGuard"
set reputation 5
set icon-id 140
set offset 1602565

config entry
edit 1

set protocol 6
set port 443
set ip-range-number 27
set ip-number 80
next

edit 2
set protocol 6
set port 8890
set ip-range-number 27
set ip-number 80
next

edit 3
set protocol 17
set port 53
set ip-range-number 18
set ip-number 31
next

edit 4
set protocol 17
set port 8888
set ip-range-number 18
set ip-number 31
next

end

Example of internet-service-custom

config firewall internet-service-custom
edit "custom1"

set comment "custom1"
config entry

edit 1
set protocol 6

config port-range
edit 1

set start-port 30
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set end-port 33
next

end
set dst "google-drive" "icloud"
next

end
next

end

Example of get command:

get firewall internet-service-summary
Version: 00004.00002
Timestamp: 201611291203
Number of Entries: 1349

Certificate key size selection (397883)

FortiOS will now support different SSL certificate key lengths from the HTTPS server. FortiOS will select a key
size from the two options of 1024 and 20148, to match the key size (as close as possible, rounding up) on the
HTTS server. If the size of the key from the server is 512 or 1024 the proxy will select a 1024 key size. If the key
size from the servers is over 1024, the proxy will select a key size of 2048.

CLI changes:

In ssl-ssh-profile remove:

l certname-rsa

l certname-dsa

l certname-ecdsa

In vpn certificate setting, add the following options :

l certname-rsa1024

l certname-rsa2048

l certname-dsa1024

l certname-dsa2048

l certname-ecdsa256

l certname-ecdsa384

AWS API integration for dynamic firewall address object (400265)

Some new settings have been added to the CLI that will support instance information being retrieved directly
from the AWS server. The IP address of a newly launched instance can be automatically added to a certain
firewall address group if it meets specific requirements. The new address type is:ADDR_TYPE_AWS

New CLI configuration settings:

The AWS settings

config aws
set access-key
set secret-key
set region
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set vpc-id
set update-interval

l access-key - AWS access key.
l secret-key - AWS secret key.
l region - AWS region name.
l vpc-id - AWSVPC ID.
l update-interval - AWS service update interval (60 - 600 sec, default = 60).

The AWS address:

config firewall address
edit <address name>

set type aws
set filter <filter values>

The filter can be a combination of any number of conditions, as long as the total length

of filter is less than 2048 bytes. The syntax for the filter is:

<key1=value1> [& <key2=value2>] [| <key3=value3>]

For each condition, it includes a key and value, the supported keys are:

1. instanceId, (e.g. instanceId=i-12345678)
2. instanceType, (e.g. instanceType=t2.micro)
3. imageId, (e.g. imageId=ami-123456)
4. keyName, (e.g. keyName=aws-key-name)
5. architecture, (e.g. architecture=x86)
6. subnetId, (e.g. subnetId=sub-123456)
7. placement.availabilityzone, (e.g. placement.availabilityzone=us-east-1a)
8. placement.groupname, (e.g. placement.groupname=group-name)
9. placement.tenancy, (e.g. placement.tenancy=tenancy-name)
10. privateDnsName, (e.g. privateDnsName=ip-172-31-10-211.us-west-2.compute.internal)
11. publicDnsName, (e.g. publicDnsName=ec2-54-202-168-254.us-west-2.compute.amazonaws.com)
12. AWS instance tag, each tag includes a key and value, the format of tag set is: tag.Name=Value, maximum of 8

tags are supported.

Internet service configuration (405518)

To make the CLI configuration of Internet service configuration more intuitive, the settings for Internet service in
Explicit Web proxy are closer to those in the Firewall police. An Internet service enable switch has been added to
the Explicit Web proxy with the same text description as the Firewall policy.

CLI:

The relevant options in the firewall policy are:

config firewall policy
edit 1

set internet-service enable
set internet-service-id 327681 1572864 917519 393225 1572888 1572877 917505
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next
end

The Explicit Web proxy is now has these options:

config firewall proxy-policy
edit 1
set uuid f68e0426-dda8-51e6-ac04-37fc3f92cadf
set proxy explicit-web
set dstintf "port9"
set srcaddr "all"
set internet-service 2686980
set action accept
set schedule "always"
set logtraffic all
next
end

Changes to SSL abbreviate handshake (407544)

The SSL handshake process has changed to make troubleshooting easier.

l In order to better identify which clients have caused SSL errors, the WAD SSL log will use the original source
address rather than the source address of packets.

l The return value of wad_ssl_set_cipher is checked.
l The wad_ssl_session_match has been removed because it will add the connection into bypass cache and

bypass further inspection.
l DSA and ECDSA certificates are filtered for admin-server-cert
l cert-inspect is reset after a WADmatch to a Layer 7 policy
l An option to disable the use of SSL abbreviate handshake has been added

CLI addition

config firewall ssl setting
set abbreviate-handshake [enable|disable]

NGFW mode in the VDOM - NAT & SSL Inspection considerations (407547)

Due to how the NGFW Policy mode works, it can get complicated in the two areas of NAT and SSL Deep
Inspection. To match an application against a policy, some traffic has to pass through the FortiGate in order to be
properly identified. Once that happens may end up getting mapped to a different policy, where the new policy will
be appropriately enforced.

NAT

In the case of NAT being used, the first policy that is triggered to identify the traffic might require NAT enabled for
it to work correctly. i.e., without NAT enabled it may never be identified, and thus not fall through. Let's use a
very simple example:

Policy 1: Block Youtube

Policy 2: Allow everything else (with NAT enabled)
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Any new session established will never be identified immediately as Youtube, so it'll match policy #1 and let some
traffic go to try and identify it. Without NAT enabled to the Internet, the session will never be setup and thus
stuck here.

Solution:

l NAT for NGFW policies must be done via Central SNAT Map
l Central SNAT Map entries now have options for 'srcintf', 'dstintf' and 'action'.
l If no IP-pools are specified in the Central SNAT entry, then the outgoing interface address will be used.
l NGFW policies now must use a single default ssl-ssh-profile. The default ssl-ssh-profile can be configured under

the system settings table.

SSL

In the case of SSL inspection, the issue is a bit simpler. For each policy there are 3 choices:

1. No SSL,
2. Certificate Only
3. Deep Inspection.
For 1. and 2. there is no conflict and the user could enable them inter-changeably and allow policy fallthrough.

The issue happens when:

l The first policy matched, usesCertificate Only
l After the application is detected, it re-maps the session to a new policy which hasDeep Inspection enabled

This switching of behavior is the main cause of the issue.

Solution:

l Multiple SSL profiles have been replaced with a single page of settings
l The user can setup exemptions for destination web category, source IP or etc.

CLI

Changes

config system settings
set inspection-mode flow
set policy-mode [standard | ngfw]

Has been changed to:

config system settings
set inspection-mode flow
set ngfw-mode [profile-based | policy-based]

l ngfw-mode - Next Generation Firewall mode.
l profile-based - Application and web-filtering is configured using profiles applied to policy entries.
l policy-based - Application and web-filtering is configured as policy match conditions.
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Additions

Setting the vdom default ssl-ssh-profile

config system settings
set inspection-mode flow
set ngfw-mode policy-based
set ssl-ssh-profile <profile>

ssl-ssh-profile - VDOM SSL SSH profile.

Setting srcintf, dstintf, action on the central-snat policy

config firewall central-snat-map
edit <id>

set srcintf <names or any>
set dstintf <names or any>
set action (permit | deny)

l srcintf - Source interface name.
l dstintf - Destination interface name.
l action - Action of central SNAT policy.

GUI

System settings, VDOM settings list/dialog:

l A field has been added to show the default ssl-ssh-profile

IPv4/v6 Policy list and dialogs:

l In NGFW policy-based mode, there are added tool tips under NAT columns/fields to indicate that NAT must be
configured via Central SNAT Map. Additionally, links to redirect to Central SNAT list were added.

l Default ssl-ssh-profile is shown in the policy list and dialog for any policies doing NGFW (`application,
application-categories, url-categories`) or UTM (`av-profile etc.) inspection.
l Default ssl-ssh-profile is disabled from editing in policy list dialog

Central SNAT Policy list and dialogs:

l In both profile-based & policy-based ngfw-mode, fields for srcintf, dstintf were added to Central
SNAT policies entries.

l In policy-based mode only, a toggle-switch forNAT Action was added in Central SNAT policy dialog. The
action is also configurable from the Action column in Central SNAT policy list.

SSL/SSH Inspection list:

l In policy-based mode only, the navigation bar link to SSL/SSH Inspection redirects to the profiles list
l In policy-based mode only, the SSL/SSH Inspection list table indicates which profile is the current VDOM default.

Additionally, options are provided in the list menu and context menu to change the current VDOM default.
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Support HTTP policy for flow-based inspection (411666)

It is possible to impliment an HTTP-policy in a VDOM that is using the Flow-based inspection mode. Enabling the
HTTP-policy causes the traffic to be redirected to WAD so that the traffic can be properly matched and processed.

Support for CA chain downloading to improve certificate verification (369270)

During certificate verification, if the certificate chain is not complete and CA issuer information exists in the
certifcate, FortiOS attempts to download intermediate/root CAs from the HTTP server and attempts to perform
chain verification. The downloaded CAs are saved in a cache (max 256) to be re-used for future certificate
validation. CAs are removed from the cache if they are inactive or not needed for more than 1 hour.

CA chain downloading is used to improve verification results for certificates that are difficult to verify. The CAs are
kept in the cache to improve performance.

NewWAN Optimization Features in 5.6

WAN Optimization GUI changes (283422)

Improvements have been made to the WAN Optimization Profiles and Authentication Group pages.

New Proxy Features in 5.6

Explicit proxy supports multiple incoming ports and port ranges (402775, 398687)

Explicit proxy can now be configured to listen on multiple ports on the same IP as well as listen for HTTP and
HTTPS on those same (or different) ports.

Define the IP ranges using a hyphen (-). As shown below, port_high is not necessary to specify if port_low is
equal to port_high.

CLI syntax

config web-proxy explicit
set http-incoming-port <port_low> [-<port_high>]

end

Explicit proxy supports IP pools (402221)

Added a new command, poolname, to config firewall proxy-policy. When setting the IP pool name
with this command, the outgoing IP will be selected.

CLI syntax

config firewall proxy-policy
edit <example>

set poolname <name>
end
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Option to remove unsupported encoding from HTTP headers (392908)

Added a new command to config web-proxy profile that, when enabled, allows the FortiGate to strip
out unsupported encoding from request headers, and correctly block banned words. This is to resolve issues
when attempting to successfully block content using Google Chrome.

CLI syntax:

config web-proxy profile
edit <example>

set strip-encoding {enable | disable}
end

New authentication process for explicit web proxying (386474, 404355)

While in Proxy inspection mode, explicit proxy options can be set underNetwork > Explicit Proxy. These
settings will affect what options are available for creating proxy policies under Policy & Objects > Proxy
Policy. From here you may create new policies with Proxy Type set to either Explicit Web, Transparent
Web, or FTP.

Authentication will be triggered differently when configuring a transparent HTTP policy. Before such a policy can
be configured, you must enable HTTP Policy Redirect under Security Profiles > Proxy Options.

Added Internet services to explicit proxy policies (386182)

Added two new commands to config firewall proxy-policy. FortiOS can use the Internet Service
Database (introduced in 5.4.1) as the web-proxy policy matching factor.

CLI syntax:

config firewall proxy-policy
edit <example>

set internet-service <application-id>
set internet-service-custom <application-name>

Virtual WAN link in an explicit proxy firewall policy (385849, 396780)

Virtual WAN link (VWL) interfaces may now be set as the destination interface in an explicit proxy policy, routing
traffic properly using basic virtual WAN link load balance settings. This is now configurable through both the CLI
under firewall proxy-policy and the GUI.

Added application ID and category setting on the explicit proxy enabled service (379330)

This feature introduces support for application ID/category in the service of explicit proxy as one policy selection
factor. The intent is to identify the application type based on the HTTP request with IPS application type
detection function. It is similar to the current firewall explicit address, but it is implemented as a service type, and
you can select the application ID/ category to define explicit service. Of course, now it must be an HTTP-based
application.

CLI syntax

config firewall service custom
edit "name"

set app-service-type [disable|app-id|app-category]
next
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end

Explicit Proxy - populate pac-file-url in transparent mode (373977)

You can now use manageip to populate pac-file-url in transparent opmode. Previously, in the CLI, when
displaying pac-file-url, the code only tries to get interface IP to populate pac-file-url.

CLI syntax

config vdom
edit root
config system settings

set opmode transparent
set manageip 192.168.0.34/24

end
config web-proxy explicit

set pac-file-server-status enable
get pac-file-url [url.pac]

end

SSL deep inspection OCSP support for Explicit Proxy (365843)

OCSP support for SSL deep inspection added for Explicit Proxy.

CLI syntax

config vpn certificate setting
set ssl-ocsp-status [enable|disable]
set ssl-ocsp-option [certificate|server]

end

Timed out authentication requests are now logged (357098)

CLI syntax

config web-proxy explicit
set trace-auth-no-rsp [enable|disable]

end
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Firewall concepts

There are a number of foundational concepts that are necessary to have a grasp of before delving into the details
of how the FortiGate firewall works. Some of these concepts are consistent throughout the firewall industry and
some of them are specific to more advanced firewalls such as the FortiGate. Having a solid grasp of these ideas
and terms can give you a better idea of what your FortiGate firewall is capable of and how it will be able to fit
within your networks architecture.

This chapter describes the following firewall concepts:

l What is a Firewall?
l FortiGate Modes
l How Packets are handled by FortiOS
l Interfaces and Zones
l Access Control Lists
l IPv6
l NAT
l "IP Pools" on page 984
l Services and TCP ports
l "Firewall policies" on page 948
l "Firewall policies" on page 948
l "SSL/SSH Inspection" on page 966
l "VPN Policies" on page 1013
l "DSRI" on page 1013
l "Interface Policies" on page 1014
l "Local-In Policies" on page 1020
l "Security Policy 0" on page 1021
l "Deny Policies" on page 1022
l "Accept Policies" on page 1022
l IPv6 Policies
l "Fixed Port" on page 1022
l "Endpoint Security" on page 1022
l "Traffic Logging" on page 1023

What is a Firewall?
The term firewall originally referred to a wall intended to confine a fire or potential fire within a building. Later
uses refer to similar structures, such as the metal sheet separating the engine compartment of a vehicle or
aircraft from the passenger compartment.

A firewall can either be software-based or hardware-based and is used to help keep a network secure. Its primary
objective is to control the incoming and outgoing network traffic by analyzing the data packets and determining
whether it should be allowed through or not, based on a predetermined rule set. A network's firewall builds a
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bridge between an internal network that is assumed to be secure and trusted, and another network, usually an
external (inter)network, such as the Internet, that is not assumed to be secure and trusted.

Network Layer or Packet Filter Firewalls

Stateless Firewalls

Stateless firewalls are the oldest form of these firewalls. They are faster and simple in design requiring less
memory because they process each packet individually and don't require the resources necessary to hold onto
packets like stateful firewalls. Stateful firewalls inspect each packet individually and check to see if it matches a
predetermined set of rules. According to the matching rule the packet is either be allowed, dropped or rejected. In
the case of a rejection an error message is sent to the source of the traffic. Each packet is inspected in isolation
and information is only gathered from the packet itself. Simply put, if the packets were not specifically allowed
according to the list of rules held by the firewall they were not getting through.

Stateful Firewalls

Stateful firewalls retain packets in memory so that they can maintain context about active sessions and make
judgments about the state of an incoming packet's connection. This enables Stateful firewalls to determine if a
packet is the start of a new connection, a part of an existing connection, or not part of any connection. If a packet
is part of an existing connection based on comparison with the firewall's state table, it will be allowed to pass
without further processing. If a packet does not match an existing connection, it will be evaluated according to the
rules set for new connections. Predetermined rules are used in the same way as a stateless firewall but they can
now work with the additional criteria of the state of the connection to the firewall.

Best Practices Tip for improving performance:

Blocking the packets in a denied session can take more cpu processing resources than
passing the traffic through. By putting denied sessions in the session table, they can
be kept track of in the same way that allowed session are so that the FortiGate unit
does not have to redetermine whether or not to deny all of the packets of a session
individually. If the session is denied all packets of that session are also denied.

In order to configure this you will need to use 2 CLI commands

config system setting
     set ses-denied-traffic enable
     set block-session-timer <integer 1 - 300> (this determines in
seconds how long, in seconds, the session is kept in the table)
end

Application Layer Firewalls

Application layer filtering is yet another approach and as the name implies it works primarily on the Application
Layer of the OSI Model.

Application Layer Firewalls actually, for lack of a better term, understand certain applications and protocols.
Examples would be FTP, DNS and HTTP. This form of filtration is able to check to see if the packets are actually
behaving incorrectly or if the packets have been incorrectly formatted for the protocol that is indicated. This
process also allows for the use of deep packet inspection and the sharing of functionality with Intrusion
Prevention Systems (IPS).
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Application-layer firewalls work on the application level of the TCP/IP stack (i.e., all browser traffic, or all telnet or
ftp traffic), and may intercept all packets traveling to or from an application. They block other packets (usually
dropping them without acknowledgment to the sender). Application firewalls work much like a packet filter but
application filters apply filtering rules (allow/block) on a per process basis instead of filtering connections on a per
port basis.

On inspecting all packets for improper content, firewalls can restrict or prevent outright the spread of networked
computer worms and trojans. The additional inspection criteria can add extra latency to the forwarding of packets
to their destination.

Proxy Servers

A proxy server is an appliance or application that acts as an intermediary for communicating between computers.
A computer has a request for information. The packets are sent to the designated resource but before they can
get there they are blocked by the proxy server saying that it will take the request and pass it on. The Proxy Server
processes the request and if it is valid it passes onto the designated computer. The designated computer gets the
packet and processes the request, sending the answer back to the proxy server. The proxy server sends the
information back to the originating computer. It’s all a little like a situation with two people who refuse to talk
directly with each other using someone else to take messages back and forth.

From a security stand point a Proxy Server can serve a few purposes:

l Protects the anonymity of the originating computer
l The two computers never deal directly with each other
l Packets that are not configured to be forwarded are dropped before reaching the destination computer.
l If malicious code is sent it will affect the Proxy server with out affecting the originating or sending computer.

Proxies can perform a number of roles including:

l Content Filtering
l Caching
l DNS proxy
l Bypassing Filters and Censorship
l Logging and eavesdropping
l Gateways to private networks
l Accessing service anonymously

UTM/ NGFW

Unified Threat Management and Next Generation Firewall are terms originally coined by market research firms
and refer to the concept of a comprehensive security solution provided in a single package. It is basically
combining of what used to be accomplished by a number of different security technologies all under a single
umbrella or in this case, a single device. On the FortiGate firewall this is achieved by the use of Security Profiles
and optimized hardware.

In effect it is going from a previous style of firewall that included among its features:

l Gateway Network Firewall
l Routing
l VPN

To a more complete system that includes:

942 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 9 - Firewall Firewall concepts

l Gateway Network Firewall
l Routing
l VPN
l Traffic Optimization
l Proxy Services
l Content Filtering
l Application Control
l Intrusion Protection
l Denial of Service Attack Protection
l Anti-virus
l Anti-spam
l Data Leak Prevention
l Endpoint Control of Security Applications
l Load Balancing
l WiFi Access Management
l Authentication Integration into Gateway Security
l Logging
l Reporting

Advantages of using Security Profiles

l Avoidance of multiple installations.
l Hardware requirements are fewer.
l Fewer hardware maintenance requirements.
l Less space required.
l Compatibility - multiple installations of products increase the probability of incompatibility between systems.
l Easier support and management.
l There is only one product to learn therefore a reduced requirement of technical knowledge.
l Only a single vendor so there are fewer support contracts and Service Level Agreements.
l Easier to incorporated into existing security architecture.
l Plug and play architecture.
l Web based GUI for administration.

FortiGate Modes
The FortiGate unit has a choice of modes that it can be used in, either NAT mode or Transparent mode. The
FortiGate unit is able to operate as a firewall in both modes, but some of its features are limited in Transparent
mode. It is always best to choose which mode you are going to be using at the beginning of the set up. Once you
start configuring the device, if you want to change the mode you are going to lose all configuration settings in the
change process.

NAT Mode

NAT mode is the most commonly used mode by a significant margin and is thus the default setting on the device.
As the name implies the function of NAT is commonly used in this mode and is easily configured but there is no
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requirement to use NAT. The FortiGate unit performs network address translation before IP packets are sent to
the destination network.

These are some of the characteristics of NAT mode:

l Typically used when the FortiGate unit is a gateway between private and public networks.
l Can act as a router between multiple networks within a network infrastructure.
l When used, the FortiGate unit is visible to the networks that is connected to.
l Each logical interface is on a distinct subnet.
l Each Interface needs to be assigned a valid IP address for the subnet that it is connected to it.

Transparent Mode

Transparent mode is so named because the device is effectively transparent in that it does not appear on the
network in the way that other network devices show as a nodes in the path of network traffic. Transparent mode is
typically used to apply the FortiOS features such as Security Profiles etc. on a private network where the
FortiGate unit will be behind an existing firewall or router.

These are some of the characteristics of Transparent mode:

l The FortiGate unit is invisible to the network.
l All of its interfaces are on the same subnet and share the same IP address.
l The FortiGate unit uses a Management IP address for the purposes of Administration.
l Still able to use NAT to a degree, but the configuration is less straightforward

In Transparent mode, you can also perform NAT by creating a security policy or policies that translates the source
addresses of packets passing through the FortiGate unit as well as virtual IP addresses and/or IP pools.

How Packets are handled by FortiOS
To give you idea of what happens to a packet as it makes its way through the FortiGate unit here is a brief
overview. This particular trip of the packet is starting on the Internet side of the FortiGate firewall and ends with
the packet exiting to the Internal network. An outbound trip would be similar. At any point in the path if the packet
is going through what would be considered a filtering process and if fails the filter check the packet is dropped and
does not continue any further down the path.

This information is covered in more detail in other in the Troubleshooting chapter of the FortiOS Handbook in the
Life of a Packet section.

The incoming packet arrives at the external interface. This process of entering the device is referred to as
ingress.

Step #1 - Ingress

1. Denial of Service Sensor
2. IP integrity header checking
3. IPsec connection check
4. Destination NAT
5. Routing
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Step #2 - Stateful Inspection Engine

1. Session Helpers
2. Management Traffic
3. SSL VPN
4. User Authentication
5. Traffic Shaping
6. Session Tracking
7. Policy lookup

Step #3 - Security Profiles scanning process

1. Flow-based Inspection Engine
2. IPS
3. Application Control
4. Data Leak Prevention
5. Email Filter
6. Web Filter
7. Anti-virus
8. Proxy-based Inspection Engine
9. VoIP Inspection
10. Data Leak Prevention
11. Email Filter
12. Web Filter
13. Anti-virus
14. ICAP

Step #4 - Egress

1. IPsec
2. Source NAT
3. Routing

Interfaces and Zones
A Firewall is a gateway device that may be the nexus point for more than 2 networks. The interface that the traffic
is coming in on and should be going out on is a fundamental concern for the purposes of routing as well as
security. Routing, policies and addresses are all associated with interfaces. The interface is essentially the
connection point of a subnet to the FortiGate unit and once connected can be connected to other subnets.

The following types of interfaces are found on a FortiGate:

l Interface , this can refer to a physical or virtual interface
l Zone
l Virtual Wired Pair
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Interfaces

Physical interfaces or not the only ones that need to be considered. There are also virtual interfaces that can be
applied to security policies. VLANs are one such virtual interface. Interfaces if certain VPN tunnels are another.

Policies are the foundation of the traffic control in a firewall and the Interfaces and addressing is the foundation
that policies are based upon. Using the identity of the interface that the traffic connects to the FortiGate unit tells
the firewall the initial direction of the traffic. The direction of the traffic is one of the determining factors in
deciding how the traffic should be dealt with. You can tell that interfaces are a fundamental part of the policies
because, by default, this is the criteria that the policies are sorted by.

Zones

Zones are a mechanism that was created to help in the administration of the firewalls. If you have a FortiGate
unit with a large number of ports and a large number of nodes in you network the chances are high that there is
going to be some duplication of policies. Zones provide the option of logically grouping multiple virtual and
physical FortiGate firewall interfaces. The zones can then be used to apply security policies to control the
incoming and outgoing traffic on those interfaces. This helps to keep the administration of the firewall simple and
maintain consistency.

For example you may have several floors of people and each of the port interfaces could go to a separate floor
where it connects to a switch controlling a different subnet. The people may be on different subnets but in terms
of security they have the same requirements. If there were 4 floors and 4 interfaces a separate policy would have
to be written for each floor to be allowed out on to the Internet off the WAN1 interface. This is not too bad if that is
all that is being done, but now start adding the use of more complicated policy scenarios with Security Profiles,
then throw in a number of Identity based issues and then add the complication that people in that organization
tend to move around in that building between floors with their notebook computers.

Each time a policy is created for each of those floors there is a chance of an inconsistency cropping up. Rather
than make up an additional duplicate set of policies for each floor, a zone can be created that combines multiple
interfaces. And then a single policy can created that uses that zone as one side of the traffic connection.

You cannot add physical interfaces associated with VLANs to zones.

Virtual Wire Pair

The simplified explanation is that two interfaces are set up so that whatever traffic goes through one of the pair is
replicated on the other. They are most commonly used when scanning is needed on an interface without
interfering with the traffic. On interface "A", everything goes through unaffected. The replicated traffic on
interface "B" is sent to an analysand of some kind and the traffic can be thoroughly scanned without worry of
impacting performance.

When two physical interfaces are setup as a Virtual Wire Pair, they will have no IP addressing and are treated
similar to a transparent mode VDOM. All packets accepted by one of the interfaces in a virtual wire pair can only
exit the FortiGate through the other interface in the virtual wire pair and only if allowed by a virtual wire pair
firewall policy. Packets arriving on other interfaces cannot be routed to the interfaces in a virtual wire pair. A
FortiGate can have multiple virtual wire pairs.

You cannot add VLANs to virtual wire pairs. However, you can enable wildcard VLANs for a virtual wire pair. This
means that all VLAN-tagged traffic can pass through the virtual wire pair if allowed by virtual wire pair firewall
policies.
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Access Control Lists
Access Control Lists (ACLs) use NP6 offloading to drop IPv4 or IPv6 packets at the physical network interface
before the packets are analyzed by the CPU. On a busy appliance this can really help the performance. This
feature is available on FortiGates with NP6 processors and is not supported by FortiGates with NP6lite
processors.

The ACL feature is available only on FortiGates with NP6-accelerated interfaces. ACL checking is one of the first
things that happens to the packet and checking is done by the NP6 processor. The result is very efficient
protection that does not use CPU or memory resources.

Use the following command to configure IPv4 ACL lists:

config firewall acl
edit 0

set status enable
set interface <interface-name>
set scraddr <firewall-address>
set dstaddr <firewall-address>
set service <firewall-service>

end

Use the following command to configure IPv6 ACL lists:

config firewall acl6
edit 0

set status enable
set interface <interface-name>
set scraddr <firewall-address6>
set dstaddr <firewall-address6>
set service <firewall-service>

end

Where:

<interface-name> is the interface on which to apply the ACL. There is a hardware limitation that needs to be
taken into account. The ACL is a Layer 2 function and is offloaded to the ISF hardware, therefore no CPU
resources are used in the processing of the ACL. It is handled by the inside switch chip which can do hardware
acceleration, increasing the performance of the FortiGate. The ACL function is only supported on switch fabric
driven interfaces.

<firewall-address> <firewall-address6> can be any of the address types used by the FortiGate,
including address ranges. The traffic is blocked not on an either or basis of these addresses but the combination
of the two, so that they both have to be correct for the traffic to be denied. To block all of the traffic from a specific
address all you have to do is make the destination address ALL.

Because the blocking takes place at the interface based on the information in the packet header and before any
processing such as NAT can take place, a slightly different approach may be required. For instance, if you are
trying to protect a VIP which has an external address of x.x.x.x and is forwarded to an internal address of y.y.y.y,
the destination address that should be used is x.x.x.x, because that is the address that will be in the packet's
header when it hits the incoming interface.

<firewall-service> the firewall service to block. Use ALL to block all services.
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Firewall policies
The firewall policy is the axis around which most of the other features of the FortiGate firewall revolve. A large
portion of the settings in the firewall at some point will end up relating to or being associated with the firewall
policies and the traffic that they govern. Any traffic going through a FortiGate unit has to be associated with a
policy. These policies are essentially discrete compartmentalized sets of instructions that control the traffic flow
going through the firewall. These instructions control where the traffic goes, how it’s processed, if it’s processed
and even whether or not it’s allowed to pass through the FortiGate.

When the firewall receives a connection packet, it analyzes the packet’s source address, destination address, and
service (by port number). It also registers the incoming interface, the outgoing interface it will need to use and the
time of day. Using this information the FortiGate firewall attempts to locate a security policy that matches the
packet. If it finds a policy that matches the parameters it then looks at the action for that policy. If it isACCEPT
the traffic is allowed to proceed to the next step. If the Action isDENY or a match cannot be found the traffic is
not allowed to proceed.

The 2 basic actions at the initial connection are eitherACCEPT orDENY:

l If the Action isACCEPT, thee policy action permits communication sessions. There may be other packet
processing instructions, such as requiring authentication to use the policy or restrictions on th source and
destination of the traffic.

l If the Action isDENY, the policy action blocks communication sessions, and you can optionally log the denied
traffic. If no security policy matches the traffic, the packets are dropped. ADENY security policy is needed when it
is required to log the denied traffic, also called “violation traffic”.

There are two other Actions that can be associated with the policy:

l LEARN - This is a specialized variation on the ACCEPT action. That is set up to allow traffic but to keep traffic
logs so that the administrator can go through them to learn what kind of traffic has to be dealt with.

l IPsec - This is an ACCEPT action that is specifically for IPsec VPNs.

There can also be a number of instructions associated with a FortiGate firewall in addition to the ACCEPT or
DENY actions, some of which are optional. Instructions on how to process the traffic can also include such things
as:

l Logging Traffic
l Authentication
l Network Address Translation or Port Address Translation
l Use Virtual IPs or IP Pools
l Caching
l Whether the source of the traffic is based on address, user, device or a combination
l Whether to treat as regular traffic or IPsec traffic
l What certificates to use
l Security profiles to apply
l Proxy Options
l Traffic Shaping

Firewall policy parameters

Asmentioned before, for traffic to flow through the FortiGate firewall there must be a policy that matches its
parameters:
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Incoming Interface(s)

This is the interface or interfaces that the traffic is first connection to the FortiGate unit by. The exception being
traffic that the FortiGate generates itself. This is not limited to the physical Ethernet ports found on the device.
The incoming interface can also be a logical or virtual interface such as a VPN tunnel, a Virtual WAN link or a
wireless interface.

Outgoing Interface(s)

After the firewall has processed the traffic it needs to leave a port to get to its destination and this will be the
interface or interfaces that the traffic leaves by. This interface, like the Incoming Interface is not limited to only
physical interfaces.

Source Address(es)

The addresses that a policy can receive traffic from can be wide open or tightly controlled. For a public web server
that the world at large should be able to access, the best choice will be “all”. If the destination is a private web
server that only the branch offices of a company should be able to access or a list of internal computers that are
the only ones allowed to access an external resource then a group of preconfigured addresses is the better
strategy.

Additional parameters under the Source Address, though they are not mandatory are:

l Source User(s)
This parameter is based on a user identity that can be from a number of authentication authorities. It will be an
account or group that has been set up in advance that can be selected from the drop down menu. The exception to
this is the feature that allows the importing of LDAPUsers. When the feature is used, a small wizard window will
appear to guide the user through the setup. The caveat is that the LDAP server object in the User and Device >
Authentication > LDAP Servers section has to be already configured to allow the use of this import feature.

l Source Device Type
This parameter is for narrowing down the traffic sending devices to those that the FortiGate is familiar with. Again
the contents of this parameter need to be a preconfigured object and these are defined at User and Device >
Custom Devices & Groups. This parameter can limit the devices that can connect to this policy to those specific
MAC addresses that are already known by the FortiGate and are approved for the policy.

Destination Address(es)

In the same way that the source address may need to be limited, the destination address can be used as a traffic
filter. When the traffic is destined for internal resources the specific address of the resource can be defined to
better protect the other resources on the network. One of the specialized destination address options is to use a
Virtual IP address. The destination address doesn’t need to be internal you can define policies that are only for
connecting to specific addresses on the Internet.

Internet service(s)

In this context, and Internet service is a combination of one or more addresses and one or more services
associated with a service found on the Internet such as an update service for software.

Schedule

The time frame that is applied to the policy. This can be something as simple as a time range that the sessions
are allowed to start such as between 8:00 am and 5:00 pm. Something more complex like business hours that
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include a break for lunch and time of the session’s initiation may need a schedule group because it will require
multiple time ranges to make up the schedule.

Service

The service or service chosen here represent the TCP/IP suite port numbers that will most commonly be used to
transport the named protocols or group of protocols. This will be a little different than Application Control which
looks more closely at the packets to determine the actual protocol used to create them.

Without all six (possibly 8) of these things matching, the traffic will be declined. Each traffic flow requires a policy
and the direction is important as well. Just because packets can go from point A to point B on port X does not
mean that the traffic can flow from point B to point A on port X. A policy must be configured for each direction.

When designing a policy there is often reference to the traffic flow, but most communication is a two way
connection so trying to determine the direction of the flow can be somewhat confusing. If traffic is HTTPweb
traffic the user sends a request to the web site, but most of the traffic flow will be coming from the web site to the
user. Is the traffic flow considered to be from the user to the web site, the web site to the user or in both
directions? For the purposes of determining the direction for a policy the important factor is the direction of the
initiating communication. The user is sending a request to the web site so this is the initial communication and
the web site is just responding to it so the traffic will be from the users network to the Internet.

A case where either side can initiate the communication like between two internal interfaces on the FortiGate unit
would be a more likely situation to require a policy for each direction.

What is not expressly allowed is denied

One of the fundamental ideas that can be found in just about any firewall is the rule than anything that is not
expressly allowed is by default denied. This is the foundation for any strategy of protecting your network. Right
out of the box, once you have your FortiGate device connected into your network and hooked up with your ISP
your network is protected. Nothing is getting out or in so it is not very convenient, but you don’t have to worry that
between the time you hooked it up and the point that you got all of the policies in place that someone could have
gotten in and done something to your resources. The reason that this needs to be kept in mind when designing
policies is because you cannot assume that any traffic will be allowed just because it makes sense to do so. If you
want any kind of traffic to make it past the FortiGate firewall you need to create a policy that will allow that traffic.
To maintain the protection of the network should also make sure that the any policy you create allows only the
traffic you intend to go only to where you specifically want it to go and when you want it to go there.

Example

You have a web server on your network that is meant to provide a collaborative work environment web site for
your employees and a partner company for a project over the course of the next 3 months.

It is theoretically possible to allow connections into your network to any device on that network for any service and
at any time. The problem with this is that we might not want just anybody looking at those resources. Sadly, no
matter how much it is wished otherwise, not everybody on the Internet can be trusted. Which means we now have
to be very specific in our instructions as to what traffic to allow into the network. Each step that we take towards
being more specific as to what we allow means that there is that much more that is not allowed and the level of
protection of a resources is directly proportional to the amount of traffic that is not allowed. If somebody can’t get
at it they can’t damage or steal it.

Limiting where the traffic is allowed to go to means that other computers on your network besides the web-server
are protected.
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l Limiting where the traffic is allowed to come from means that, if feasible, you can limit the systems that can access
the web server to just employees or the partner company computers.

l Limiting the services to just web traffic means that a malicious person, even if they were connection from a
computer at the partner organization could only use the features of web traffic to do anything malicious.

l Limiting the policy to the time span of the project would mean that even if the IT department forgot to remove the
policy after the end of the project than no computer from the other company could be used to do anything malicious
through the policy that allowed the traffic.

This is just a very basic example but it shows the underlying principles of how the idea that anything not expressly
allowed is by default denied can be used to effectively protect your network.

Policy order

Another important factor in how firewall policies work is the concept of precedence of order or if you prefer a more
recognizable term, “first come, first served”.

It is highly likely that even after only a relatively small number of policies have been created that there will be
some that overlap or are subsets of the parameters that the policies use to determine which policy should be
matched against the incoming traffic. When this happens there has to be a method to determine which policy
should be applied to the packet. The method which is used by most firewalls it based on the order of the
sequence of the policies.

If all of the policies were placed in a sequential list the process to match up the packet would start at the top of
the list and work its way down. It would compare information about the packet, specifically these points of
information:

1. The interface the packet connected to the FortiGate firewall
2. The source of the packet. This can include variations of the address, user credentials or device
3. The destination of the packet. This can include address or Internet service
4. The interface the packet would need to use to get to the destination address based on the routing table
5. The service or port the packet is destined for
6. The time that the packet connected to the FortiGate
As soon as the a policy is reached that matches all of the applicable parameters, the instructions of that policy are
applied and the search for any other matching policies is stopped. All subsequent policies are disregarded. Only 1
policy is applied to the packet.

If there is no matching policy among the policies that have been configured for traffic the packet finally drops
down to what is always the last policy. It is an implicit policy. One of a few that are referred to by the term
“policy0”. This policy denies everything.

The implicit policy is made up of the following settings:

l Incoming Interface: any
l Source Address: any
l Outgoing Interface: any
l Destination Address: any
l Action: DENY

The only setting that is editable in the implicit policy is the logging of violation traffic.

A logical best practice that comes from the knowledge of how this process works is to make sure that the more
specific or specialized a policy is, the closer to the beginning of the sequence it should be. The more general a
policy is the higher the likelihood that it could include in its range of parameters a more specifically targeted
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policy. The more specific a policy is, the higher the probability that there is a requirement for treating that traffic in
a specific way.

Example

For security reasons there is no FTP traffic allowed out of a specific subnet so there is a policy that states that any
traffic coming from that subnet is denied if the service is FTP, so the following policy was created:

Policy #1

Source Interface Internal1

Source Address 192.168.1.0/24

Source User(s) <left at default setting>

Source Device
Type <left at default setting>

Outgoing
Interface

WAN1

Destination
Address 0.0.0.0/0.0.0.0

Service FTP

Schedule always

Action deny

Now as these things usually go it turns out that there has to be an exception to the rule. There is one very secure
computer on the subnet that is allowed to use FTP and once the content has been checked it can them be
distributed to the other computer on the subnet. So a second firewall policy is created.

Policy #2

Source Interface Internal1

Source Address 192.168.1.38/32

Source User(s) <left at default setting>

Source Device
Type <left at default setting>

Outgoing
Interface WAN1

Destination
Address 0.0.0.0/0.0.0.0
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Service FTP

Schedule always

Action Allow

By default, a policy that has just been created will be placed last in the sequence so that it is less likely to interfere
with existing policies before it can be moved to its intended position. If you look at Policy #2 you will notice that it
is essentially the same as Policy #1 exempt for the Source Address and the Action. You will also notice that the
Source Address of the Policy #2 is a subset of the Source address in policy #1. This means that if nothing further
is done, Policy #2 will never see any traffic because the traffic will always be matched by Policy #1 and processed
before it has a chance to reach the second policy in the sequence. For both policies to work as intended Policy #2
needs to be moved to before Policy #1 in the sequence.

Policy Identification

There are two ways to identify a policy. The most obvious is the policy name and this is easily read by humans,
but with a little effort it is possible to have a policy without a name, therefore every policy has an ID number.

When looking at the policy listing it can appear as if the policies are identified by the sequence number in the far
left column. The problem is that this number changes as the position of the policy in the sequence changes. The
column that correctly identifies the policy, and the value sticks with the policy is the "ID" column. This column is
not shown by default in the listing but can be added to the displayed columns by right clicking on the column
heading bar and selecting it from the list of possible columns.

When looking in the configuration file the sequence is based upon the order of the policies as they are in the file
just as they are in the list in the GUI. However, if you need to edit the policy in the CLI you must use the ID
number.

UUID Support

Universally Unique Identifier (UUID) attributes have been added to policies to improve functionality when working
with FortiManager or FortiAnalyzer units. If required, the UUID can be set manually through the CLI.

CLI Syntax:

config firewall {policy/policy6/policy46/policy64}
edit 1

set uuid <example uuid: 8289ef80-f879-51e2-20dd-fa62c5c51f44>
next

end

Nturbo support CAPWAP traffic

NTurbo is used for IPSEC+IPS case. The IPSEC SA info is passed to NTURBO as part of VTAG for control packet
and will be used for the xmit.

If the packets need to go through IPSEC interface, the traffic will be always offloaded
to Nturbo. But for the case that SA has not been installed to NP6 because of hardware
limitation or SA offload disable, the packets will be sent out through raw socket by IPS
instead of Nturbo, since the software encryption is needed in this case.
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CLI :

Previously, NTurbo could only be enabled or disabled globally. The setting of np-acceleration has been added to
the firewall policy context instead of just the global context.

CLI command in the firewall policy to enable/disable NTurbo acceleration.

config firewall policy
edit 1

set np-accelation [enable|disable]
end

When IPS is enabled for VPN IPsec traffic, the data can be accelerated by NTurbo.

Learning mode for policies

The learning mode feature is a quick and easy method for setting a policy to allow everything but to log it all so
that it can later be used to determine what restrictions and protections should be applied. The objective is to
monitor the traffic not act upon it while in Learning mode.

Once the Learn action is enabled, functions produce hard coded profiles that will be enabled on the policy. The
following profiles are set up:

l AntiVirus (av-profile)
l Web Filter ( webfilter-profile)
l Anti Spam( spamfilter-profile )
l Data Leak Prevention (dlp-sensor )
l Intrusion Protection (ips-sensor )
l Application Control (application-list )
l Proxy Options (profile-protocol-options)

l These UTM profiles are all using Flow mode
l SSL inspection is always disable for the Learn option
l These profiles are static and cannot be edited.

Profiles that are not being used are:

l DNS Filter (Does not have a Flow mode)
l Web Application Firewall(Does not have a Flow mode)
l CASI(Almost all signatures in CASI require SSL deep inspection. Without SSL inspection, turning on CASI serves

little purpose)

The ability to allow policies to be set to a learning mode is enabled on a per VDOM basis.

config system settings
set gui-policy-learning [enable | disable]
end

Once the feature is enabled on the VDOM, Learn is an available Action option when editing a policy.

Because this feature requires a minimum level of logging capabilities, it is only
available on FortiGates with hard drives. Smaller models may not be able to use this
feature.
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Once the Learning policy has been running for a sufficient time to collect needed information a report can be
looked at by going to Log & Report > Learning Report.

The Report can be either a Full Report or a Report Summary

The time frame of the report can be 5 minutes, 1 hour, or 24 hours.

The Learning Report includes:

Deployment Methodology

l Test Details
l Start time
l End time
l Model
l Firmware

l Policy List

Executive Summary

l Total Attacks Detected
l Top Application Category
l Top Web Category
l Top Web Domain
l Top Host by Bandwidth
l Host with Highest Session Count

Security and Threat Prevention

l High Risk Applications
l Application Vulnerability Exploits
l Malware, botnets and Spyware/Adware
l At-Risk Devices and Hosts

User Productivity

l Application Usage
l Top Application Categories
l Top Social Media Applications
l Top Video/Audio Streaming Applications
l Top Peer to Peer Applications
l Top Gaming Applications

l Web Usage
l Top Web Categories
l Top Web Applications
l Top Web Domains

Policy Modes
You can operate your FortiGate or individual VDOMs in Next Generation Firewall (NGFW) Policy Mode.
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You can enable NGFW policy mode by going to System > Settings, setting the Inspection mode to Flow-
based and setting the NGFW mode to Policy-based. When selecting NGFW policy-basedmode you also
select the SSL/SSH Inspection mode that is applied to all policies

Flow-based inspection with profile-based NGFW mode is the default in FortiOS 5.6.

Or use the following CLI command:

config system settings
set inspection-mode flow
set policy-mode {standard | ngfw}

end

NGFW policy mode and NAT

If your FortiGate is operating in NAT mode, rather than enabling source NAT in individual NGFW policies you go
to Policy & Objects > Central SNAT and add source NAT policies that apply to all matching traffic. In many
cases you may only need one SNAT policy for each interface pair. For example, if you allow users on the internal
network (connected to port1) to browse the Internet (connected to port2) you can add a port1 to port2 Central
SNAT policy similar to the following:
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Application control in NGFW policy mode

You configure Application Control simply by adding individual applications to security policies. You can set the
action to accept or deny to allow or block the applications.

Web Filtering in NGFW mode

You configureWeb Filtering by adding URL categories to security policies. You can set the action to accept or
deny to allow or block the applications.
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Other NGFW policy mode options

You can also combine both application control and web filtering in the same NGFW policy mode policy. Also if the
policy accepts applications or URL categories you can also apply Antivirus, DNS Filtering, and IPS profiles in
NGFW mode policies as well a logging and policy learning mode.

Security profiles
Where security policies provide the instructions to the FortiGate unit for controlling what traffic is allowed through
the device, the Security profiles provide the screening that filters the content coming and going on the network.
Security profiles enable you to instruct the FortiGate unit about what to look for in the traffic that you don’t want,
or want to monitor, as it passes through the device.

A security profile is a group of options and filters that you can apply to one or more firewall policies. Security
profiles can be used by more than one security policy. You can configure sets of security profiles for the traffic
types handled by a set of security policies that require identical protection levels and types, rather than repeatedly
configuring those same security profile settings for each individual security policy.

For example, while traffic between trusted and untrusted networks might need strict antivirus protection, traffic
between trusted internal addresses might need moderate antivirus protection. To provide the different levels of
protection, you might configure two separate profiles: one for traffic between trusted networks, and one for traffic
between trusted and untrusted networks.
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Security profiles are available for various unwanted traffic and network threats. Each are configured separately
and can be used in different groupings as needed. You configure security profiles in the Security Profiles menu
and applied when creating a security policy by selecting the security profile type.

There is a separate handbook for the topic of the Security Profiles, but because the Security Profiles are applied
through the Firewall policies it makes sense to have at least a basic idea of what the security profile do and how
they integrate into the FortiGate's firewall policies. The following is a listing and a brief description of what the
security profiles offer by way of functionality and how they can be configured into the firewall policies.

l HTTP
l SMTP
l POP3
l IMAP
l FTP
l NNTP
l MAPI
l DNS
l IM

AntiVirus

Antivirus is used as a catch all term to describe the technology for protection against the transmission of
malicious computer code sometimes referred to as malware. As anyone who has listened to the media has heard
that the Internet can be a dangerous place filled with malware of various flavors. Currently, the malware that is
most common in the Internet, in descending order, is Trojan horses, viruses, worms, adware, back door exploits,
spyware and other variations. In recent years, not only has the volume of malicious software become greater than
would have been believed when it first appeared but the level of sophistication has risen as well.

The Antivirus Filter works by inspecting the traffic that is about to be transmitted through the FortiGate. To
increase the efficiency of effort it only inspects the traffic being transmitted via the protocols that it has been
configured to check. Before the data moves across the FortiGate firewall from one interface to another it is
checked for attributes or signatures that have been known to be associated with malware. If malware is detected,
it is removed.

Web Filtering

Malicious code is not the only thing to be wary of on the Internet. There is also the actual content. While the
content will not damage or steal information from your computer there is still a number of reasons that would
require protection from it.

In a setting where there are children or other sensitive people using the access provided by a connected computer
there is a need to make sure that images or information that is not appropriate is not inadvertently displayed to
them. Even if there is supervision, in the time it takes to recognize something that is inappropriate and then
properly react can expose those we wish to protect. It is more efficient to make sure that the content cannot reach
the screen in the first place.

In an organizational setting, there is still the expectation that organization will do what it can to prevent
inappropriate content from getting onto the computer screens and thus provoking an Human Resources incident.
There is also the potential loss of productivity that can take place if people have unfiltered access to the Internet.
Some organizations prefer to limit the amount of distractions available to tempt their workers away from their
duties.
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The Web filter works primarily by looking at the destination location request for a HTTP(S) request made by the
sending computer. If the URL is on a list that you have configured to list unwanted sites, the connection will be
disallowed. If the site is part of a category of sites that you have configured to deny connections to the session will
also be denied. You can also configure the content filter to check for specific key strings of data on the actual web
site and if any of those strings of data appear the connection will not be allowed.

The configuration for each of these protocols is handled separately.

DNS filtering is similar to Web Filtering from the viewpoint of the user. The difference is under the hood. When
using regular Web Filtering, the traffic can go through some processing steps before it gets to the point where the
web filter determines whether on not the traffic should be accepted or denied. Because the filtering takes place at
the DNS level, some sites can be denied before a lot of the additional processing takes place. This can save
resource usage on the FortiGate and help performance.

Application Control

Application Control is designed to allow you to determine what applications are operating on your network and to
the also filter the use of these applications as required. Application control is also for outgoing traffic to prevent
the use of applications that are against an organization’s policy from crossing the network gateway to other
networks. An example of this would be the use of proxy servers to circumvent the restrictions put in place using
the Web Filtering.

Intrusion Protection (IPS)

Intrusion Prevention System is almost self explanatory. In the same way that there is malware out on the Internet
that the network needs to be protected from there are also people out there that take a more targeted approach
to malicious cyber activity. No operating system is perfect and new vulnerabilities are being discovered all of the
time. An intrusion prevention system is designed to look for activity or behavior that is consistent with attacks
against your network. When attack like behavior is detected it can either be dropped or just monitored depending
on the approach that you would like to take.

As new vulnerabilities are discovered they can be added to the IPS database so that the protection is current.

Anti-Spam

Spam or unsolicited bulk email is said to account for approximately 90% of the email traffic on the Internet.
Sorting through it is both time consuming and frustrating. By putting an email filter on policies that handle email
traffic, the amount of spam that users have to deal with can be greatly reduced.

Data Leak Prevention (DLP)

Data Leak Prevention is used to prevent sensitive information from leaving your network. When people think of
security in the cyber-world one of the most common images is that of a hacker penetrating your network and
making off with your sensitive information, but the other way that you can lose sensitive data is if someone
already on the inside of your network sends it out. This does not have to be an act of industrial espionage. It can
just be a case of not knowing the policies of the organization or a lack of knowledge of security or laws concerning
privacy.

For instance, a company may have a policy that they will not reveal anyone’s Social Security number, but an
employee emails a number of documents to another company that included a lengthy document that has a Social
Security number buried deep within it. There is not malicious intent but if the information got out there could be
repercussions.
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If an organization has any information in a digital format that it cannot afford for financial or legal reasons, to
leave its network, it makes sense to have Data Leak Prevention in place as an additional layer of protection.

VoIP

Voice over IP is essentially the protocols for transmitting voice or other multimedia communications over Internet
Protocol networks such as the Internet. The Security Profiles VoIP options apply the SIP Application Level
Gateway (ALG) to support SIP through the FortiGate unit. The SIP ALG can also be used to protect networks
from SIP-based attacks.

ICAP

Internet Content Adaptation Protocol (ICAP) off loads HTTP traffic to another location for specialized processing.
The purpose of this module when triggered is to send the incoming HTTP traffic over to a remote server to be
processed thus taking some of the strain off of the resources of the FortiGate unit. The reasons for the
specialized process could be anything from more sophisticated Antivirus to manipulation of the HTTP headers
and URLs.

Just like other components of the FortiGate, there is the option for different Proxy Option profiles so that you can
be very granular in your control of the workings of the FortiGate. In the case of the Proxy Option profiles the thing
that you will want to focus on is the matching up of the correct profile to a firewall policy that is using the
appropriate protocols. If you are creating a Proxy Option profile that is designed for policies that control SMTP
traffic into your network you only want to configure the settings that apply to SMTP. You do not need or want to
configure the HTTP components.

The Web Application Firewall performs a similar role as devices such as Fortinet's FortiWeb, though in a more
limited fashion. It's function is to protect internal web servers from malicious activity specific to those types of
servers. This includes things like SQL injection, Cross site Scripting and trojans. It uses signatures and other
straight forward methods to protect the web servers, but it is a case of turning the feature on or off and the actions
are limited toAllow,MonitororBlock.To get protection that is more sophisticated, granular and intelligent, as
will as having many more features, it is necessary to get a device like the FortiWeb that can devote more
resources to the process. However, if your needs are simple, choosing to use the WAF feature built into the
FortiGate should provide valuable protection.

The comfort client feature to mitigates this potential issue by feeding a trickle of data while waiting for the scan to
complete so as to let the user know that processing is taking place and that there hasn’t been a failure in the
transmission. This slow transfer rate continues until the antivirus scan is complete. Once the file has been
successfully scanned without any indication of viruses the transfer will proceed at full speed.

Without prior approval the email should not be forwarded.
Please be environmentally friendly and don’t print out emails
For questions regarding the purchasing of our products please call...

Security Profile Groups

It may seem counter intuitive to have a topic on Security Profile Groups in the Firewall Chapter/Handbook when
there is already a chapter/handbook on Security Profiles, but there are reasons.

l Security Profile Groups are used exclusively in the configuration of a firewall policy, which is described in the
Firewall Chapter/Handbook.

l The CLI commands for creating and using Security Profile Groups are in the firewall configuration context of the
command line structure of settings.
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The purpose of Security Profile Groups is just the same as other groups such as Address, Service, and VIP
groups. They are used to save time and effort in the administration of the FortiGate when there are a lot of
policies with a similar pattern of Security Profile use. In a fairly basic network setup with a handful of policies it
doesn't seem like it would be worth the effort to set up groups of security profiles but if you have a large complex
configuration with hundreds of policies where many of them use the same security profiles it can definitely save
some effort and help prevent missing adding an important profile from a policy. As an added benefit, when it
comes time to add or change the profiles for the policies that use the Security Profile Groups, the changes only
have to be made to the group, not each policy.

The most difficult part about using Security Profile Groups is making them visible in the GUI.

Making Security Profile Groups visible in the GUI

By default, the Security Profile Groups are not visible in the GUI. Neither the ability to assign one to a policy nor
the ability to configure the members of a group are available by default. You will not find the option to enable
Security Profile Groups under System > Feature Visibility either. Instead, they only become visible in the GUI
once one has been created and assigned to a policy. This must be done the first time through the CLI using the
following syntax:

config system settings
set gui-dynamic-profile-display enable

end

Step 1 - Create a Security Profile Group:

Enter the command:

config firewall profile-group

Use the edit command to give a name to and create a new Security Profile Group

(profile-group) # edit test-group

Configure the members of the group by setting the name of the desired profile in the field for the related
profile/sensor/list. The options are:

av-profile Name of an existing Antivirus profile.

webfilter-profile Name of an existing Web filter profile.

dnsfilter-profile Name of an existing DNS filter profile.

spamfilter-profile Name of an existing Spam filter profile.

dlp-sensor Name of an existing DLP sensor.

ips-sensor Name of an existing IPS sensor.

application-list Name of an existing Application list.

voip-profile Name of an existing VoIP profile.

icap-profile Name of an existing ICAP profile.
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waf-profile Name of an existing Web application firewall profile.

profile-protocol-
options

Name of an existing Protocol options profile.

ssl-ssh-profile Name of an existing SSL SSH profile.

Example:

set av-profile default
set profile-plrotocol-options default
end

Always set the profile-protocol-options setting before attempting
to save the profile group. If this is not set, you will get the error:

node_check_object fail! for profile-protocol-options
Attribute 'profile-protocol-options' MUST be set.
Command fail. Return code -56

Step 2 - Add a Security Profile to a policy

Now that there is group to add to a policy we can configure a policy to allow the use of a Security Policy group.
This is also done in the CLI.

In the following example only the command necessary to enable the use and pick of a Security Policy group have
been listed.

config firewall policy
edit 0

set utm-status enable
set profile-type group
set profile-group test-group

Step 3 - The appearance in the GUI of the Security Profile Group configuration features

l Under Security Profiles there is a menu item called Profile Groups that can be used to create new and edit
existing profile groups.

l In the Edit Policywindow for IPv4 and IPv6 policies there is a Use Security Profile Group field to enable or
disable the use of the groups.
l In the window, policy groups can be created or edited by clicking on the appropriate icons next to or in the drop

down menu
l In the policy listing window there is a Security Profiles column.

l Right or left clicking on the icon for the group brings up editing options either via a slide out window or a drop
down menu, respectively.
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Proxy Option Components

Any time a security profile that requires the use of a proxy is enabled the Proxy Options field will be displayed.
Certain inspections defined in security profiles require that the traffic be held in proxy while the inspection is
carried out and so the Proxy Options are there to define the parameters of how the traffic will be processed and to
what level the traffic will be processed. In the same way that there can be multiple security profiles of a single
type there can also be a number of unique Proxy Option profiles so that as the requirements for a policy differ
from one policy to the next you can also configure a different Proxy Option profile for each individual policy or you
can use one profile repeatedly.

The Proxy Options refer to the handling of the following protocols:

l HTTP
l SMTP
l POP3
l IMAP
l FTP
l NNTP
l MAPI
l DNS
l IM

The configuration for each of these protocols is handled separately.

It should also be noted that these configurations apply to only the Security Profiles Proxy-based processes and
not the Flow-based processes.

The use of different proxy profiles and profile options

Just like other components of the FortiGate, there is the option for different Proxy Option profiles so that you can
be very granular in your control of the workings of the FortiGate. In the case of the Proxy Option profiles the thing
that you will want to focus on is the matching up of the correct profile to a firewall policy that is using the
appropriate protocols. If you are creating a Proxy Option profile that is designed for policies that control SMTP
traffic into your network you only want to configure the settings that apply to SMTP. You do not need or want to
configure the HTTP components.

Oversized File Log

This setting is for those that would like to log the occurrence of oversized files being processed. It does not
change how they are processed it only enables the FortiGate unit to log that they were either blocked or allowed
through. A common practice is to allow larger files through without antivirus processing. This allows you to get an
idea of how often this happens and decide on whether or not to alter the settings relating to the treatment of
oversized files.

The setting of the threshold for what is considered to be an oversized file is located in the Oversized File / Email
Threshold that is found in some of the protocol options for the Proxy Options.

Protocol Port Mapping

While each of the protocols listed has a default TCP port that is commonly used, the level of granularity of control
on the FortiGate firewall allows that the port used by the protocols can be individually modified in each separate
Profile. It can also be set to inspect any port with flowing traffic for that particular protocol. The headers of the
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packets will indicate which protocol generated the packet. To optimize the resources of the unit the mapping and
inspection of protocols can be enabled or disabled depending on your requirements.

Comfort Clients

When proxy-based antivirus scanning is enabled, the FortiGate unit buffers files as they are downloaded. Once
the entire file is captured, the FortiGate unit begins scanning the file. During the buffering and scanning
procedure, the user must wait. After the scan is completed, if no infection is found, the file is sent to the next step
in the process flow. If the file is a large one this part of the process can take some time. In some cases enough
time that some users may get impatient and cancel the download.

The comfort client feature to mitigates this potential issue by feeding a trickle of data while waiting for the scan to
complete so as to let the user know that processing is taking place and that there hasn’t been a failure in the
transmission. This slow transfer rate continues until the antivirus scan is complete. Once the file has been
successfully scanned without any indication of viruses the transfer will proceed at full speed.

If there is evidence of an infection the FortiGate unit caches the URL and drops the connection. The client does
not receive any notification of what happened because the download to the client had already started. Instead,
the download stops and the user is left with a partially downloaded file. If the user tries to download the same file
again within a short period of time, the cached URL is matched and the download is blocked. The client receives
the Infection cache message replacement message as a notification that the download has been blocked. The
number of URLs in the cache is limited by the size of the cache.

Client comforting is available for HTTP and FTP traffic. If your FortiGate unit supports SSL content scanning and
inspection, you can also configure client comforting for HTTPS and FTPS traffic.

Buffering the entire file allows the FortiGate unit to eliminate the danger of missing an
infection due to fragmentation because the file is reassembled before examination.
Client comforting can send unscanned and therefore potentially infected content to
the client. You should only enable client comforting if you are prepared to accept this
risk. Keeping the client comforting interval high and the amount low will reduce the
amount of potentially infected data that is downloaded.

Oversized File/Email Threshold

This is another feature that is related to antivirus scanning. The FortiGate unit has a finite amount of resources
that can be used to buffer and scan a file. If a large file such as an ISO image or video file was to be downloaded
this could not only overwhelm the memory of the FortiGate, especially if there were other large files being
downloaded at the same time, but could exceed it as well. For this reason, how to treat large files needs to be
addressed.

A threshold is assigned to determine what should be considered an oversize file or email. This can be set at any
size from 1 MB to 50 MB. Any file or email over this threshold will not be processed by the Antivirus Security
Profiles. Once a file is determined to be oversized it must be then determined whether to allow it or to block it.

These settings are not a technical decision but a policy one that will depend on your comfort level with letting files
into your network. As there often is, there is a compromise between convenience or ease of use and security. If
you want to go for a high peace of mind level you can configure the firewall to block oversized files and thus no
files would be coming into the network that have not been scanned. If you are looking for optimizing the memory
of the FortiGate unit and making sure that everybody is getting the files they want, you can lower the threshold
and allow files that are over the threshold.
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It should be noted that in terms of probability that malware is more likely to be found in
smaller files than in larger files. A number of administrators take this into account
when they lower the default threshold so as to lessen the impact on memory if they
see the FortiGate unit going into conserve mode on a regular basis.

Chunked Bypass

The HTTP section allows the enabling of “Chunked Bypass”. This refers to the mechanism in version 1.1 of HTTP
that allows a web server to start sending chunks of dynamically generated output in response to a request before
actually knowing the actual size of the content. Where dynamically generated content is concerned this means
that there is a faster initial response to HTTP requests. From a security stand point it means that the content will
not be held in the proxy as an entire file before proceeding.

Allow Fragmented Messages

The specifications of RFC 2046 allow for the breaking up of emails and sending the fragments in parallel to be
rebuilt and read at the other end by the mail server. It was originally designed to increase the performance over
slower connections where larger email messages were involved. It will depend on your mail configuration if this is
even possible for your network but outside of Microsoft Outlook and Outlook Express, not many email clients are
set up to break up messages like this. The drawback of allowing this feature is that if malware is broken up
between multiple fragments of the message the risk is run that it will not be detected by some antivirus
configurations because the code may not all be present at the same time to identify.

Append Email Signature

The Append Email Signature is used when an organization would like to ensure that over and above our in this
case underneath the existing personal signatures of the sender, all of the emails going out of their network have
the appropriate “boilerplate”, for lack of a better term. These appended emails do not replace existing signatures.
They are as the feature states, appended to the email.

Examples could include things like:

l Without prior approval the email should not be forwarded.
l Please be environmentally friendly and don’t print out emails
l For questions regarding the purchasing of our products please call...

It can be anything that the organization would like as long as it is in text format. The use of this feature usually
works best in an environment where there is some standardization of what goes into the personal signatures of
the senders so that there is no duplication or contradiction of information in the signatures.

SSL/SSH Inspection

While the profile configuration for SSL/SSH Inspection is found in the Security Profiles section it is enabled in
the firewall policy by enabling any of the security profiles. Choosing which of the SSL/SSH Inspection profiles is
all that can really be done in the policy.

The reason for having this inspection as part of the policy is the wide spread use of encryption by both legitimate
and malicious actors. The legitimate users of the Internet use encryption to hide their information from snooping
bad guy but the bad guys use encryption to hide their malicious content from being scanned for viruses and other
malicious code by security devices.
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By using the correct SSL certificates, the FortiGate can open up encrypted traffic and inspect it for malicious
content that would otherwise make it past the other profiles because they couldn't read the encrypted traffic.

There are two basic types of inspection:

l Certificate inspection, which only looks at the certificate that encrypted the packets to make sure that it is a
recognized and valid certificate.

l Full inspection, or deep inspection, that looks at all of the content of the packet. While more thorough, it also takes
up more resources to perform.

HTTP Strict Transport Security (HSTS) Protocol

HSTS is a protocol used by Google and other web browsers to prevent man-in-the-middle attacks.

When performing deep inspection, the FortiGate intercepts the https traffic and would send its own self-signed
CA certificate to the browser. If the browser is configured to use HSTS connections, it would refuse the FortiGate
CA certificate since it is not on the trusted list for Google servers.

To keep the CA certificate from being refused, the HSTS settings should be cleared from the browser.
Instructions for this vary between browsers.

To gain a deeper understanding read the SSL/SSH Inspection section in the Security Profile chapter.

Mirroring SSL inspected traffic

It is possible to "mirror" or send a copy of traffic decrypted by SSL inspection to one or more FortiGate interfaces
so that the traffic can be collected by a raw packet capture tool for archiving or analysis. This feature is available if
the inspection mode is set to flow-based.

Decryption, storage, inspection, and use decrypted content is subject to local privacy
rules. Use of these features could enable malicious users with administrative access to
your FortiGate to harvest sensitive information submitted using an encrypted channel.

In this example, the setting enables the policy to send all traffic decrypted by the policy to the FortiGate port1 and
port2 interfaces.

config firewall policy
edit 0

set ssl-mirror enable
set ssl-mirror-intf port1 port2
end

RPC over HTTP

How protocol options profiles and SSL inspection profiles handle RPC (Remote Procedure Calls) over HTTP
traffic can be configured separately from normal HTTP traffic. The configuration is done in the CLI.

Configuration in Protocol Options

config firewall profile-protocol-options
edit 0

set rpc-over-http [disable|enable]
end
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Configuration in SSL/SSH inspection

config firewall ssl-ssh-profile
edit deep inspection

set rpc-over-http [disable|enable]
end

IPv6
Internet Protocol version 6 (IPv6) will succeed IPv4 as the standard networking protocol of the Internet. IPv6
provides a number of advances over IPv4 but the primary reason for its replacing IPv4 is its limitation in
addresses. IPv4 uses 32 bit addresses which means there is a theoretical limit of 2 to the power of 32. The IPv6
address scheme is based on a 128 bit address or a theoretical limit of 2 to the power of 128.

Possible Addresses:

l IPv4 = 4,294,967,296 (over 4 billion)
l IPv6 = 340,282,366,920,938,463,463,374,607,431,768,211,456 (over 340 undecillion - We had to look that term

up. We didn’t know what a number followed by 36 digits was either)

Assuming a world population of approximately 8 billion people, IPv6 would allow for each individual to have
approximately 42,535,295,865,117,200,000,000,000,000 devices with an IP address. That’s 42 quintillion
devices.

There is little likelihood that you will ever need to worry about these numbers as any kind of serious limitation in
addressing but they do give an idea of the scope of the difference in the available addressing.

Aside from the difference of possible addresses there is also the different formatting of the addresses that will
need to be addressed.

A computer would view an IPv4 address as a 32 bit string of binary digits made up of 1s and 0s, broken up into 4
octets of 8 digits separated by a period “.”

Example:

10101100.00010000.11111110.00000001

To make number more user friendly for humans we translate this into decimal, again 4 octets separated by a
period “.”which works out to:

172.16.254.1

A computer would view an IPv6 address as a 128 bit string of binary digits made up of 1s and 0s, broken up into 8
octets of 16 digits separated by a colon “:”

1000000000000001:0000110110111000:101011000001000:1111111000000001:000000000000000
0:0000000000000000:0000000000000000:0000000000000000

To make number a little more user friendly for humans we translate this into hexadecimal, again 8 octets
separated by a colon “:” which works out to:

8001:0DB8:AC10:FE01:0000:0000:0000:0000:

Because any four-digit group of zeros within an IPv6 address may be reduced to a single zero or altogether
omitted, this address can be shortened further to:

8001:0DB8:AC10:FE01:0:0:0:0

or
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8001:0DB8:AC10:FE01::

Some of the other benefits of IPv6 include:

l More efficient routing
l Reduced management requirement
l Stateless auto-reconfiguration of hosts
l Improved methods to change Internet Service Providers
l Better mobility support
l Multi-homing
l Security
l Scoped address: link-local, site-local and global address space

IPv6 in FortiOS

From an administrative point of view IPv6 works almost the same as IPv4 in FortiOS. The primary differences are
the use of IPv6 format for addresses and fewer address types for IPv6. There is also no need for NAT if the
FortiGate firewall is the interface between IPv6 networks. If the subnets attached to the FortiGate firewall are
IPv6 and IPv4 NAT can be configured between the 2 different formats. This will involve either configuring a dual
stack routing or IPv4 tunneling configuration. The reason for this is simple. NAT was developed primarily for the
purpose of extending the number of usable IPv4 addresses. IPv6’s addressing allows for enough available
addresses so the NAT is no longer necessary.

When configuring IPv6 in FortiOS, you can create a dual stack route or IPv4-IPv6 tunnel. A dual stack routing
configuration implements dual IP layers, supporting both IPv4 and IPv6, in both hosts and routers. An IPv4-IPv6
tunnel is essentially similar, creating a tunnel that encapsulates IPv6 packets within IPv4 headers that carry these
IPv6 packets over IPv4 tunnels. The FortiGate unit can also be easily integrated into an IPv6 network. Connecting
the FortiGate unit to an IPv6 network is exactly the same as connecting it to an IPv4 network, the only difference
is that you are using IPv6 addresses.

By default the IPv6 settings are not displayed in the Web-based Manager. It is just a matter of enabling the
display of these feature to use them through the web interface. To enable them just go to System > Feature
Select and select IPv6. Once enabled, you will be able to use IPv6 addresses as well as the IPv4 addressing for
the following FortiGate firewall features:

l Static routing
l Policy Routing
l Packet and network sniffing
l Dynamic routing (RIPv6, BGP4+, and OSPFv3)
l IPsec VPN
l DNS
l DHCP
l SSL VPN
l Network interface addressing
l Security Profiles protection
l Routing access lists and prefix lists
l NAT and Transparent mode
l NAT 64 and NAT 66
l IPv6 tunnel over IPv4 and IPv4 tunnel over IPv6
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l Logging and reporting
l Security policies
l SNMP
l Authentication
l Virtual IPs and groups
l IPv6 over SCTP
l IPv6-specific troubleshooting, such as ping6

Dual Stack routing configuration

Dual stack routing implements dual IP layers in hosts and routers, supporting both IPv6 and IPv4. A dual stack
architecture supports both IPv4 and IPv6 traffic and routes the appropriate traffic as required to any device on the
network. Administrators can update network components and applications to IPv6 on their own schedule, and
even maintain some IPv4 support indefinitely if that is necessary. Devices that are on this type of network, and
connect to the Internet, can query Internet DNS servers for both IPv4 and IPv6 addresses. If the Internet site
supports IPv6, the device can easily connect using the IPv6 address. If the Internet site does not support IPv6,
then the device can connect using the IPv4 addresses. In the FortiOS dual stack architecture it is not just the
basic addressing functions that operate in both versions of IP. The other features of the appliance such as
Security Profiles and routing can also use both IP stacks.

If an organization with a mixed network uses an Internet service provider that does not support IPv6, they can use
an IPv6 tunnel broker to connect to IPv6 addresses that are on the Internet. FortiOS supports IPv6 tunneling over
IPv4 networks to tunnel brokers. The tunnel broker extracts the IPv6 packets from the tunnel and routes them to
their destinations.

IPv6 Tunneling

IPv6 Tunneling is the act of tunneling IPv6 packets from an IPv6 network through an IPv4 network to another IPv6
network. This is different than Network Address Translation (NAT) because once the packet reaches its final
destination the true originating address of the sender will still be readable. The IPv6 packets are encapsulated
within packets with IPv4 headers, which carry their IPv6 payload through the IPv4 network. This type of
configuration is more appropriate for those who have completely transitional over to IPv6, but need an Internet
connection, which is still mostly IPv4 addresses.

The key to IPv6 tunneling is the ability of the 2 devices, whether they are a host or a network device, to be dual
stack compatible. They have to be able to work with both IPv4 and IPv6 at the same time. In the process the entry
node of the tunnel portion of the path will create an encapsulating IPv4 header and transmit the encapsulated
packet. The exit node at the end of the tunnel receives the encapsulated packet. The IPv4 header is removed.
The IPv6 header is updated and the IPv6 packet is processed.

There are two types of tunnels in IPv6:

Automatic
tunnels

Automatic tunnels are configured by using IPv4 address information embedded in an
IPv6 address – the IPv6 address of the destination host includes information about
which IPv4 address the packet should be tunneled to.

Configured
tunnels

Configured tunnels must be configured manually. These tunnels are used when using
IPv6 addresses that do not have any embedded IPv4 information. The IPv6 and IPv4
addresses of the endpoints of the tunnel must be specified.
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Tunnel Configurations

There are a few ways in which the tunneling can be performed depending on which segment of the path between
the end points of the session the encapsulation takes place.

Network Device
to Network
Device

Dual stack capable devices connected by an IPv4 infrastructure can tunnel IPv6
packets between themselves. In this case, the tunnel spans one segment of the path
taken by the IPv6 packets.

Host to Network
Device

Dual stack capable hosts can tunnel IPv6 packets to an intermediary IPv6 or IPv4
network device that is reachable through an IPv4 infrastructure. This type of tunnel
spans the first segment of the path taken by the IPv6 packets.

Host to Host Dual stack capable hosts that are interconnected by an IPv4 infrastructure can tunnel
IPv6 packets between themselves. In this case, the tunnel spans the entire path taken
by the IPv6 packets.

Network Device
to Host

Dual stack capable network devices can tunnel IPv6 packets to their final destination
IPv6 or IPv4 host. This tunnel spans only the last segment of the path taken by the
IPv6 packets.

Regardless of whether the tunnel starts at a host or a network device, the node that does the encapsulation
needs to maintain soft state information, such as the maximum transmission unit (MTU), about each tunnel in
order to process the IPv6 packets.

Tunneling IPv6 through IPsec VPN

A variation on the tunneling IPv6 through IPv4 is using an IPsec VPN tunnel between to FortiGate devices.
FortiOS supports IPv6 over IPsec. In this sort of scenario, 2 networks using IPv6 behind FortiGate units are
separated by the Internet, which uses IPv4. An IPsec VPN tunnel is created between the 2 FortiGate units and a
tunnel is created over the IPv4 based Internet but the traffic in the tunnel is IPv6. This has the additional
advantage of make the traffic secure as well.

NAT
NAT or Network Address Translation is the process that enables a single device such as a router or firewall to act
as an agent between the Internet or Public Network and a local or private network. This “agent”, in real time,
translates the source IP address of a device on one network interface, usually the Internal, to a different IP
address as it leaves another interface, usually the interface connected to the ISP and the Internet. This enables a
single public address to represent a significantly larger number of private addresses.

The Origins of NAT

In order to understand NAT it helps to know why it was created. At one time, every computer that was part of a
network had to have it’s own addresses so that the other computers could talk to it. There were a few protocols in
use at the time, some of which were only for use on a single network, but of those that were routable, the one that
had become the standard for the Internet was IP (Internet Protocol) version 4.

When IP version 4 addressing was created nobody had any idea how many addresses would be needed. The total
address range was based on the concept of 2 to the 32nd power, which works out to be 4 294 967 296 potential
addresses. Once you eliminate some of those for reserved addresses, broadcast addresses, network addresses,
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multicasting, etc., you end up with a workable scope of about 3.2 million addressees. This was thought to be
more than enough at the time. The designers were not expecting the explosion of personal computing, the World
Wide Web or smart phones. As of the beginning of 2012, some estimate the number of computers in the world in
the neighborhood of 1 billion, and most of those computer users are going to want to be on the Internet or Search
the World Wide Web. In short, we ran out of addresses.

This problem of an address shortage was realized before we actually ran out, and in the mid 1990s 2 technical
papers called RFCs numbered 1631 (http://www.ietf.org/rfc/rfc1631.txt) and 1918
(http://tools.ietf.org/html/rfc1918), proposed components of a method that would be used as a solution until a
new addressing methodology could be implemented across the Internet infrastructure. For more information on
this you can look up IP version 6.

RFC 1631 described a process that would allow networking devices to translate a single public address to
multiple private IP addresses and RFC 1918 laid out the use of the private addresses. The addresses that were
on the Internet (Public IP addresses) could not be duplicated for them to work as unique addresses, but behind a
firewall, which most large institutions had, they could use their own Private IP addresses for internal use and the
internal computers could share the external or Public IP address.

To give an idea on a small scale how this works, image that a company has a need for 200 computer addresses.
Before Private IP addresses and NAT the company would have purchased a full Class C address range which
would have been 254 usable IP addresses; wasting about 50 addresses. Now with NAT, that company only needs
1 IP address for its 200 computers and this leaves the rest of the IP addresses in that range available for other
companies to do the same thing.

NAT gives better value than it would first appear because it is not 253 companies that can use 254 addresses but
each of those 254 companies could set up their networking infrastructures to use up to thousands of Private IP
addresses, more if they don’t all have to talk to the Internet at the same time. This process enabled the Internet
to keep growing even though we technically have many more computers networked than we have addresses.

Dynamic NAT

Dynamic NAT maps the private IP addresses to the first available Public Address from a pool of possible
Addresses. In the FortiGate firewall this can be done by using IP Pools.

Overloading

This is a form of Dynamic NAT that maps multiple private IP address to a single Public IP address but
differentiates them by using a different port assignment. This is probably the most widely used version of NAT.
This is also referred to as PAT (Port Address Translation) or Masquerading.

An example would be if you had a single IP address assigned to you by your ISP but had 50 or 60 computers on
your local network.

Say the internal address of the interface connected to the ISP was 256.16.32.65 (again an impossible address)
with 256.16.32.64 being the remote gateway. If you are using this form of NAT any time one of your computers
accesses the Internet it will be seen from the Internet as 256.16.32.65. If you wish to test this go to 2 different
computers and verify that they each have a different private IP address then go to a site that tells you your IP
address such as www.ipchicken.com. You will see that the site gives the same result of 256.16.32.65, if it
existed, as the public address for both computers.

As mentioned before this is sometimes called Port Address Translation because network device uses TCP ports
to determine which internal IP address is associated with each session through the network device. For example,
if you have a network with internal addresses ranging from 192.168.1.1 to 192.168.1.255 and you have 5
computers all trying to connect to a web site which is normally listening on port 80 all of them will appear to the
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remote web site to have the IP address of 256.16.32.65 but they will each have a different sending TCP port, with
the port numbers being somewhere between 1 and 65 535, although the port numbers between 1 to 1024 are
usually reserved or already in use. So it could be something like the following:

192.168.1.10 256.16.32.65:   port 486
192.168.1.23 256.16.32.65:   port 2409
192.168.1.56 256.16.32.65:   port 53763
192.168.1.109 256.16.32.65:   port 5548
192.168.1.201 256.16.32.65:   port 4396

And the remote web server would send the responding traffic back based on those port numbers so the network
device would be able to sort through the incoming traffic and pass it on to the correct computer.

Overlapping

Because everybody is using the relative same small selection of Private IP addresses it is inevitable that there will
be two networks that share the same network range that will need to talk with each other. This happens most
often over Virtual Private Networks or when one organization ends up merging with another. This is a case where
a private IP address may be translated into a different private IP address so there are no issues with conflict of
addresses or confusion in terms of routing.

An example of this would be when you have a Main office that is using an IP range of 172.16.0.1 to
172.20.255.255 connecting through a VPN to a recently acquired branch office that is already running with an IP
range of 172.17.1.1 to 172.17.255.255. Both of these ranges are perfectly valid but because the Branch office
range is included in the Main Office range any time the system from the Main office try to connect to an address
in the Branch Office the routing the system will not send the packet to the default gateway because according to
the routing table the address is in its own subnet.

The plan here would be to NAT in both directions so that traffic from neither side of the firewall would be in
conflict and they would be able to route the traffic. Everything coming from the Branch Office could be assigned
an address in the 192.168.1.1 to 192.168.1.255 range and everything from the Main office going to the Branch
Office could be assigned to an address in the 192.168.10.1 to 192.168.10.255 range.

Static NAT

In Static NAT one internal IP address is always mapped to the same public IP address.

In FortiGate firewall configurations this is most commonly done with the use of Virtual IP addressing.

An example would be if you had a small range of IP addresses assigned to you by your ISP and you wished to use
one of those IP address exclusively for a particular server such as an email server.

Say the internal address of the Email server was 192.168.12.25 and the Public IP address from your assigned
addresses range from 256.16.32.65 to 256.16.32.127. Many readers will notice that because one of the numbers
is above 255 that this is not a real Public IP address. The Address that you have assigned to the interface
connected to your ISP is 256.16.32.66, with 256.16.32.65 being the remote gateway. You wish to use the
address of 256.16.32.70 exclusively for your email server.

When using a Virtual IP address you set the external IP address of 256.16.32.70 to map to 192.168.12.25. This
means that any traffic being sent to the public address of 256.16.32.70 will be directed to the internal computer at
the address of 192.168.12.25

When using a Virtual IP address, this will have the added function that when ever traffic goes from 192.168.12.25
to the Internet it will appear to the recipient of that traffic at the other end as coming from 256.16.32.70.
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You should note that if you use Virtual IP addressing with the Port Forwarding enabled you do not get this
reciprocal effect and must use IP pools to make sure that the outbound traffic uses the specified IP address.

Benefits of NAT

More IP addresses Available while Conserving Public IP Addresses

As explained earlier, this was the original intent of the technology and does not need to be gone into further.

Financial Savings

Because an organization does not have to purchase IP addresses for every computer in use there is a significant
cost savings due to using the process of Network Address Translation.

Security Enhancements

One of the side benefits of the process of NAT is an improvement in security. Individual computers are harder to
target from the outside and if port forwarding is being used computers on the inside of a firewall are less likely to
have unmonitored open ports accessible from the Internet.

Ease of Compartmentalization of Your Network

With a large available pool of IP addresses to use internally a network administrator can arrange things to be
compartmentalized in a rational and easily remembered fashion and networks can be broken apart easily to
isolate for reasons of network performance and security.

Example

You have a large organization that for security reasons has certain departments that do not share network
resources.

You can have the main section of the organization set up as follows;

Network Devices 192.168.1.1 to 192.168.1.25

Internal Servers 192.168.1.26 to 192.168.1.50

Printers 192.168.1.51 to 192.168.1.75

Administration
Personnel 192.168.1.76 to 192.168.1.100

Sales People 192.168.1.101 to 192.168.1.200

Marketing 192.168.1.201 to 192.168.1.250

You could then have the following groups broken off into separate subnets:

Accounting 192.168.100.1 to 192.168.100.255
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Research and
Development 172.16.1.1 to 172.16.255.255

Executive
Management

192.168.50.1 to 192.168.50.255

Web sites and
Email Servers 10.0.50.1 to 10.0.50.255

These addresses do not have to be assigned right away but can be used as planned ranges.

NAT in Transparent Mode

Similar to operating in NAT mode, when operating a FortiGate unit in Transparent mode you can add security
policies and:

l Enable NAT to translate the source addresses of packets as they pass through the FortiGate unit.
l Add virtual IPs to translate destination addresses of packets as they pass through the FortiGate unit.
l Add IP pools as required for source address translation

A FortiGate unit operating in Transparent mode normally has only one IP address - the management IP. To
support NAT in Transparent mode, you can add a second management IP. These two management IPs must be
on different subnets. When you add two management IP addresses, all FortiGate unit network interfaces will
respond to connections to both of these IP addresses.

Use the following steps to configure NAT in Transparent mode:

1. Add two management IPs
2. Add an IP pool to the WAN1 interface
3. Add an Internal to WAN1 security policy
You can add the security policy from the web-based manager and then use the CLI to enable NAT and add the IP
pool.

The usual practice of NATing in transparent mode makes use of two management IP addresses that are on
different subnets, but this is not an essential requirement in every case.

If there is a router between the client systems and the FortiGate unit you can use the router’s capabilities of
tracking sessions to assign NATed addresses from an IP pool to the clients even if the assigned address don’t
belong to a subnet on your network.

Example

Client computer has an IP address of 1.1.1.33 on the subnet 1.1.1.0/24.

Router “A” sits between the client computer and the FortiGate (in Transparent mode) with the IP address of
1.1.1.1 on the client’s side of the router and the IP address of 192.168.1.211 on the FortiGate’s side of the router.

Use NAT to assign addresses from an address pool of 9.9.9.1 to 9.9.9.99 to traffic coming from gateway of
192.168.1.211.

To enable the return traffic to get to the original computer, set up a static route than assigns any traffic with a
destination of 9.9.9.0/24 to go through the 192.168.1.211 gateway. As long as the session for the outgoing traffic
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has been maintained, communication between the client computer and the external system on the other side of
the FortiGate will work.

.

Central NAT Table

The central NAT table enables you to define, and control with more granularity, the address translation performed
by the FortiGate unit. With the NAT table, you can define the rules which dictate the source address or address
group and which IP pool the destination address uses.

While similar in functionality to IP pools, where a single address is translated to an alternate address from a range
of IP addresses, with IP pools there is no control over the translated port. When using the IP pool for source NAT,
you can define a fixed port to guarantee the source port number is unchanged. If no fix port is defined, the port
translation is randomly chosen by the FortiGate unit. With the central NAT table, you have full control over both
the IP address and port translation.

The FortiGate unit reads the NAT rules in a top-down methodology, until it hits a matching rule for the incoming
address. This enables you to create multiple NAT policies that dictate which IP pool is used based on the source
address. The NAT policies can be rearranged within the policy list as well. NAT policies are applied to network
traffic after a security policy.

NAT 64 and NAT46

NAT64 and NAT46 are the terms used to refer to the mechanism that allows IPv6 addressed hosts to
communicate with IPv4 addressed hosts and vice-versa. Without such a mechanism an IPv6 node on a network
such as a corporate LAN would not be able to communicate with a web site that was still in a IPv4 only
environment and IPv4 environments would not be able to connect to IPv6 networks.

One of these setups involves having at least 2 interfaces, 1 on an IPv4 network and 1 on an IPv6 network. The
NAT64 server synthesizes AAAA records, used by IPv6 from A records used by IPv4. This way client-server and
peer to peer communications will be able to work between an IPv6 only client and an IPv4 server without making
changes to either of the end nodes in the communication transaction. The IPv6 network attached to the FortiGate
unit should be a 32 bit segment, (for instance 64:ff9b::/96, see RFC 6052 and RFC 6146). IPv4 address will be
embedded into the communications from the IPv6 client.

Because the IPv6 range of addresses is so much larger than the IPv4 range, a one to one mapping is not feasible.
Therefore the NAT64 function is required to maintain any IPv6 to IPv4 mappings that it synthesizes. This can be
done either statically by the administrator or automatically by the service as the packets from the IPv6 network go
through the device. The first method would be a stateless translation and the second would be a stateful
translation. NAT64 is designed for communication initiated from IPv6 hosts to IPv4 addresses. It is address
mapping like this that allows the reverse to occur between established connections. The stateless or manual
method is an appropriate solution when the NAT64 translation is taking place in front of legacy IPv4 servers to
allow those specific servers to be accessed by remote IPv6-only clients. The stateful or automatic solution is best
used closer to the client side when you have to allow some specific IPv6 clients to talk to any of the IPv4-only
servers on the Internet.

There are currently issues with NAT64 not being able to make everything accessible. Examples would be SIP,
Skype, MSN, Goggle talk, and sites with IPv4 literals. IPv4 literals being IPv4 addresses that are imbedded into
content rather than a FQDN.

Policies that employ NAT64 or NAT46 can be configured from the web-based manager as long as the feature is
enabled using the Features setting found at System > Config > Features.
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l To create a NAT64 policy go to Policy & Objects > NAT64 Policy and select Create New.
l To create a NAT46 policy go to Policy > NAT46 Policy and select Create New.

The difference between these NAT policies and regular policies is that there is no option to use the security
profiles and sensors.

NAT64 CLAT traffic is now supported by the FortiGate. CLAT traffic comes from
devices that use the SIIT translator that plays a part in affecting IPv6 - IPv4 NAT
translation.

NAT64 CLAT

NAT64 CLATtraffic is supported by FortiOS. CLAT traffic comes from devices that use the SIIT translator that
plays a part in affecting IPv6 - IPv4 NAT translation.

NAT 66

NAT 66 is Network Address Translation between 2 IPv6 network. The basic idea behind NAT 66 is no different
than the regular NAT between IPv4 networks that we are all used to. The difference are in the mechanics of how
it is performed, mainly because of the complexity and size of the addresses that are being dealt with.

In an IPv4 world, the reason for the use of NAT was usually one or a combination of the following 3 reasons:

l Improved security - actual addresses behind NAT are virtually hidden
l Amplification of addresses - hundreds of computers can use as little as a single public IP address
l Internal address stability - there is control of internal addressing. The addresses can stay the same even if Internet

Service Providers change.

In these days of security awareness the protective properties of NAT are not something that are not normally
depended on by themselves to defend a network and with the vastly enlarged IPv6 address scope there is no
longer a need to amplify the available addresses. However, the desire to have internal address control still exists.
The most common reason for using NAT66 is likely to be the maintaining of the existing address scheme of the
internal network despite changes outside of it. Imagine that you have an internal network of 2000 IP addresses
and one day the company changes its ISP and thus the addresses assigned to it. Even if most of the addressing is
handled by DHCP, changing the address scheme is going to have an impact on operations.

Addressing stability can be achieved by:

l Keeping the same provider - this would depend on the reason for the change. If the cost of this provider has become
too expensive this is unlikely. If the ISP is out of business it becomes impossible.

l Transfer the addresses from the old provider to the new one - There is little motivation for an ISP to do you a favor
for not doing business with them.

l Get your own autonomous system number - this can be too expensive for smaller organizations.
l NAT - this is the only one on the list that is in the control of IT.

There are differences between NAT66 and IPv4 NAT. Because there is no shortage of addresses most
organizations will be given a /48 network that can be translated into another /48 network. This allows for a one to
one translation, no need for port forwarding. This is a good thing because port forwarding is more complicated in
IPv6. In fact, NAT66 will actually just be the rewriting of the prefix on the address.

Example

If your current IPv6 address is
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2001:db8:cafe::/48

you could change it to

2001:db8:fea7::/48

There is an exception to the one to one translation. NAT66 cannot translate internal networks that contain 0xffff
in bits 49 through 63 - this is due to the way checksums are calculated in TCP/IP: they use the one's-complement
representation of numbers which assigns the value zero to both 0x0000 and 0xffff.

How FortiOS differentiates sessions when NATing

The basics of NAT are fairly simple. Many private addresses get translated into a smaller number of public
addresses, often just one. The trick is how the FortiGate keeps track of the return traffic because the web server,
or what ever device that was out on the Internet is going to be sending traffic back not to the private address
behind the FortiGate but to the IP address of the interface on the public side of the FortiGate.

The way this is done is by making each session unique. Most of the attributes that are available in the network
packets cannot be changed without changing where the packet will go but because the source port has to be
changed anyway in case two computer on the network used the same source port this is a useful way of making
each listing of network attributes a unique combination. As a packet goes through the NAT process FortiOS
assigns different source ports for each of the internally initiated sessions and keeping track of which port was
used for each device in a database until the session has ended. It then becomes a matter of how the port number
is selected.

In a very simple example of an environment using NAT, we will use a fictitious university with a rather large
student population. So large in fact that they use a subnet of 10.0.0.0/8 as their subnet for workstation IP
addresses. All of these private IP addresses are NATed out a single IP address. To keep the number of numeric
values in this example from getting to a confusing level, we'll just us "u.u.u.1" to refer to the public IP address
of the University and the IP address of the web server on the Internet will be "w.w.w.1".

Student A (IP address 10.1.1.56) sends an HTML request to a web server on the Internet with the IP address
w.w.w.1. The applicable networking information in the packet breaks down as follows:

Attribute Original Packet Packet after NATing

Source IP address or src-ip 10.1.1.56 u.u.u.1

Destination IP address or dst-ip: w.w.w.1 w.w.w.1

Source port or src-port: 10000 46372

Destination port or dst-port 80 80

The source IP address is now that of the public facing interface of the FortiGate and source port number is an
unused TCP port number on the FortiGate chosen by the FortiGate. Of these variable the only one the that
FortiGate can really change and still have the packet reach the correct destination, in both directions, is the
source port number.

There are a few methods of assigning the port number. First we'll look at the methods that are or have been used
in the industry but aren't used by Fortinet.
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Global pool

This method of differentiation focuses on the attribute of the source port number. In this approach a single pool of
potential port numbers is set aside for the purposes of NAT. As a pool number is assigned, it is removed from the
pool so that two sessions from different computers can not using the same port number. Once the session is over
and no longer in use by the computer, the port number is put back into the pool where it can be assigned again.

Example global pool:

Hexidecimal Decimal

Start or range 0x7000 28672

End end of range 0xF000 61440

Possible ports in range 215 32768

This is a simple approach to implement and is good if the number of connections in unlike to reach the pool size.
It would be okay for home use, but our example is for a university using 10.1.1.0/8 as a subnet. That means
16,777,214 possible IP addresses; more than this method can handle.

Fortinet does not use this method.

Global per protocol

This method uses the attributes source port number and type of protocol to differentiate between sessions.This
approach is a variation of the first one. An additional piece of information is refered to in the packet that describes
the protocol. For instance UDP or TCP. This could effectively double the number of potential addresses to NAT.

Example:

Here are two possible packets that would be considered different by the FortiGate so that any responses from the
web server would make it back to their correct original sender.

From Student A

Attribute Original Packet Packet after NATing

Source IP address or src-ip 10.1.1.56 u.u.u.1

Destination IP address or dst-ip: w.w.w.1 w.w.w.1

Protocol tcp tcp

Source port or src-port: 10000 46372

Destination port or dst-port 80 80
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From Student B

Attribute Original Packet Packet after NATing

Source IP address or src-ip 10.5.1.233 u.u.u.1

Destination IP address or dst-ip: w.w.w.1 w.w.w.1

Protocol udp udp

Source port or src-port: 26785 46372

Destination port or dst-port 80 80

Even though the source port is the same, because the protocol is different they are considered to be from
different sessions and different computers.

The drawback is that it would depend on the protocols being used be evenly distributed between TCP and UDP.
Even if this was the case the number would only double; reaching an upper limit of 65,536 possible connections.
That number is still far short of the possible more than 16 million for an IP subnet with an eight bit subnet mask
like the one in our example.

Fortinet does not use this method.

Per NAT IP Pool

This approach adds on to the previous one by adding another variable. In this case that variable is the IP
addresses on the public side of the FortiGate. By having a pool of IP addresses to assign as the source IP address
when NATing, the same number that was potentially available for the Global per protocol method can be
multiplied by the number of external IP addresses in the pool. If you can assign a second IP address to the pool,
you can double the potential number of sessions.

Example:

In this example it will be assumed that the FortiGate has 2 IP addresses that it can use. This could happen either
by using two ISPs, or by having a pool of IP addresses assigned to a single interface. For simplicity will will refer
to these IP public IP addresses as u.u.u.1 and u.u.u.2.

Here are two possible packets that would be considered different by the FortiGate so that any responses from the
web server would make it back to their correct original sender.

From Student A

Attribute Original Packet Packet after NATing

Source IP address or src-ip 10.1.1.56 u.u.u.1

Destination IP address or dst-ip: w.w.w.1 w.w.w.1

Protocol tcp tcp
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Attribute Original Packet Packet after NATing

Source port or src-port: 10000 46372

Destination port or dst-port 80 80

From Student B

Attribute Original Packet Packet after NATing

Source IP address or src-ip 10.5.1.233 u.u.u.2

Destination IP address or dst-ip: w.w.w.1 w.w.w.1

Protocol tcp tcp

Source port or src-port: 26785 46372

Destination port or dst-port 80 80

In this example we even made the protocl the same. After the NATing process all of the variables are the same
except the sourse addresss. This is still going to make it bake to the original sender.

The drawback is that if you have only one IP address for the purposes of NATing this method does not gain you
anything over the last method. Or if you do have multiple IP addresses to use it will still take quite a few to reach
the 16 million possible that the subnet is capable of handling.

Fortinet does not use this method.

Per NAT IP, destination IP, port, and protocol

This is the approach that FortiOS uses.

It uses all of the differentiation point of the previous methods, NAT IP, port number and protocol, but the
additonal information point of the destination IP is also used. So now the network information points in the packet
that the FortiGate keeps in its database to differentiate between sessions is:

l Public IP address of the FortiGate assigned by NATing
l Protocol of the traffic
l Source port assigned by the FortiGate
l Destination IP address of the packet

The last one is an especially good way to differentiate because as a theortical number, the upper limit on that is
the numbers of Public IP addresses on the whole of the Internet. Chances are that while a large number of
session from inside the University will be going to a small group of sites such as Google, Youtube, Facebook and
some others it is unlikely that they will all be going to them at the same time.
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Example:

In this example it will be assumed that the FortiGate has only one IP address.Two possible packets will be
described. The only difference in the attributes recorded will be the destination of the HTML request.These
packets are still considered to be from differnt sessions and any responses will make it back to the correct
computer.

From Student A

Attribute Original Packet Packet after NATing

Source IP address or src-ip 10.1.1.56 u.u.u.1

Destination IP address or dst-ip: w.w.w.1 w.w.w.1

Protocol tcp tcp

Source port or src-port: 10000 46372

Destination port or dst-port 80 80

From Student B

Attribute Original Packet Packet after NATing

Source IP address or src-ip 10.5.1.233 u.u.u.1

Destination IP address or dst-ip: w.w.w.2 w.w.w.2

Protocol tcp tcp

Source port or src-port: 26785 46372

Destination port or dst-port 80 80

The reason that these attributes are used to determine defferentiation between traffic is based on how the
indexes for the sessions are recorded in the database. When a TCP connection is made through a FortiGate unit,
a session is created and two indexes are created for the session. The FortiGate unit uses these indexes to guide
matching traffic to the session.

This following could be the session record for the TCP connection in the first example.

Attribute Outgoing Traffic Returning Traffic

Source IP address 10.78.33.97 (internal address) w.w.w.1

Destination address w.w.w.1 u.u.u.1
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Attribute Outgoing Traffic Returning Traffic

Protocol tcp tcp

Source port
10000 (from original computer)

46372 (assigned by NAT)
80

Destination port 80 46372 (FortiGate assigned port)

Using the FortiGate's approach for session differentiation, FortiOS only has to ensure that the assigned port,
along with the other four attributes is a unique combination to identify the session. So for example, if Student A
simultaneously makes a HTTP(port 80) connection and a HTTPS(port 443) connection the same web server this
would create another session and the index in the reply direction would be:

Attribute Outgoing Traffic Returning Traffic

Source IP address 10.78.33.97 (internal address) w.w.w.1

Destination address w.w.w.1 u.u.u.1

Protocol tcp tcp

Source port
10000 (from original computer)

46372 (assigned by NAT)
443

Destination port 443 46372 (FortiGate assigned port)

These two sessions are different and acceptable because of the different source port numbers on the returning
traffic or the destination port depending on the direction of the traffic.

Calculations for possible session numbers

The result of using these four attributes instead of just the one that was originally used is a large increase in the
number of possible unique combinations.For those who love math, the maximum number of simultaneous
connections that can be supported is:

N x R x P x D x Dp

where:

l N is the number of NAT IP addresses
l R is the port range,
l P is the number of protocols,
l D is the number of unique destination IP addresses
l Dp the number of unique destination ports.

As a rough example let's do some basic calculations
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l N - In our existing example we have already stated that there is only one public IP address that is being used by
NAT. Realistically, for a university this number would likely be larger, but we're keeping it simple.

N = 1

R - The port range for our example has already been describe and we will keep it the same.

R = 32768

P - While there are a few protocols that are involved in Internet traffic we will limit this calculation just to TCP
traffic.

P = 1

D - As mentioned before the number of unique destination addresses is growing larger every day,so figureing out
the upper limit of that numbe would be difficult to say the least. Instead we will make the assumption that most of
the university students, do to their shared interest and similar demographic will concentrate most of their web
browsing to the same sites; sites such as YouTube, Facebook, Google, Twitter, Instagram, Wikipedia etc. This is
not even taking into account the fact that many of these popular sites use load balancing and multiple IP
addresses. As an arbatrary number let's use the number 25.

D = 25

Dp - To keep things simple it is tempting to limit the destiation port to port 80, the one that many associate with
web browsing, but this would not be realistic. the use of HTTPS, port 443 is on the rise. There is also email, DNS,
FTP, NTP and a number of other background services that we use without thinking too closely about. Let's keep it
small and say ten of them.

Dp = 10

The math on this very conservative calculation is:

1 x 32768 x 1 x 25 x 10 = 8,192,000 possible NAT sessions

When you take into account that the chances of everybody being online at the same time, going only to one of
those 25 sites and not millions of others, and using only TCP not UDP or any of the other protocols, it starts to
look like this method may provide enough potential unique sessions even for a subnet as large as the one
described.

IP Pools
IP Pools are a mechanism that allow sessions leaving the FortiGate Firewall to use NAT. An IP pool defines a
single IP address or a range of IP addresses to be used as the source address for the duration of the session.
These assigned addresses will be used instead of the IP address assigned to that FortiGate interface.
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When using IP pools for NATing, there is a limitation that must be taken into account.
In order for communication to be successful in both directions, it is normal for the
source address in the packet header assigned by the NAT process to be an address
that is associated with the interface that the traffic is going through. For example, if
traffic is going out an interface with the IP address 172.16.100.1, packets would be
NATed so that the source IP address would be 172.16.100.1. This way the returning
traffic will be directed to the same interface on the same FortiGate that the traffic left
from. Even if the packets are assigned a source address that is associated with
another interface on the same FortiGate this can cause issues with asymmetrical
routing. It is possible to configure the NATed source IP address to be different than the
IP address of the interface but you have to make sure that the routing rules of the
surrounding network devices take this unorthodox approach into consideration.

There are 4 types of IP Pools that can be configured on the FortiGate firewall:

l One-to-One - in this case the only internal address used by the external address is the internal address that it is
mapped to.

l Overload - this is the default setting. Internal addresses other than the one designated in the policy can use this
address for the purposes of NAT.

l Fixed Port Range - rather than a single address to be used, there is a range of addresses that can be used as the
NAT address. These addresses are randomly assigned as the connections are made.

l Port Block Allocation - this setting is used to allocate a block of port numbers for IP pool users. Two variables will
also have to be set. The block size can be set from 64 to 4096 and as the name implies describes the number of
ports in one block of port numbers. The number of blocks per user determines how many of these blocks will be
assigned. This number can range from 1 to 128.

Be careful when calculating the values of the variables. The maximum number of ports
that are available on an address is 65,536. If you chose the maximum value for both
variables you will get a number far in excess of the available port numbers.

4096 x 128 = 524,288

One of the more common examples is when you have an email server behind your FortiGate firewall and the
range of IP addresses assigned to you by your ISP is more than one. If an organization is assigned multiple IP
addresses it is normally considered a best practice to assign a specific address other than the one used for the
Firewall to the mail server. However, when normal NAT is used the address assigned to the firewall is also
assigned to any outbound sessions. Anti-spam services match the source IP address of mail traffic that they
receive to the MX record on DNS servers as an indicator for spam. If there is a mismatch the mail may not get
through so there is a need to make sure that the NATed address assigned matches the MX record.

You can also use the Central NAT table as a way to configure IP pools.

Source IP address and IP pool address matching when using a range

When the source addresses are translated to an IP pool that is a range of addresses, one of the following three
cases may occur:

Scenario 1:

The number of source addresses equals that of IP pool addresses

In this case, the FortiGate unit always matches the IP addressed one to one.
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If you enable fixed port in such a case, the FortiGate unit preserves the original source port. This may cause
conflicts if more than one security policy uses the same IP pool, or the same IP addresses are used in more than
one IP pool.

Scenario 2:

The number of source addresses is more than that of IP pool addresses

In this case, the FortiGate unit translates IP addresses using a wrap-around mechanism. If you enable fixed port
in such a case, the FortiGate unit preserves the original source port. But conflicts may occur since users may have
different sessions using the same TCP 5 tuples.

Scenario 3:

The number of source addresses is fewer than that of IP pool addresses

In this case, some of the IP pool addresses are used and the rest of them are not be used.

ARP Replies

If a FortiGate firewall interface IP address overlaps with one or more IP pool address ranges, the interface
responds to ARP requests for all of the IP addresses in the overlapping IP pools. For example, consider a
FortiGate unit with the following IP addresses for the port1 and port2 interfaces:

l port1 IP address: 1.1.1.1/255.255.255.0 (range is 1.1.1.0-1.1.1.255)
l port2 IP address: 2.2.2.2/255.255.255.0 (range is 2.2.2.0-2.2.2.255)

And the following IP pools:

l IP_pool_1: 1.1.1.10-1.1.1.20
l IP_pool_2: 2.2.2.10-2.2.2.20
l IP_pool_3: 2.2.2.30-2.2.2.40

The port1 interface overlap IP range with IP_pool_1 is:

(1.1.1.0-1.1.1.255) and (1.1.1.10-1.1.1.20) = 1.1.1.10-1.1.1.20

The port2 interface overlap IP range with IP_pool_2 is:

(2.2.2.0-2.2.2.255) & (2.2.2.10-2.2.2.20) = 2.2.2.10-2.2.2.20

The port2 interface overlap IP range with IP_pool_3 is:

(2.2.2.0-2.2.2.255) & (2.2.2.30-2.2.2.40) = 2.2.2.30-2.2.2.40

And the result is:

l The port1 interface answers ARP requests for 1.1.1.10-1.1.1.20
l The port2 interface answers ARP requests for 2.2.2.10-2.2.2.20 and for 2.2.2.30-2.2.2.40

Select Enable NAT in a security policy and then select Dynamic IP Pool. Select an IP pool to translate the source
address of packets leaving the FortiGate unit to an address randomly selected from the IP pool. Whether or not
the external address of an IP Pool will respond to an ARP request can be disabled. You might want to disable the
ability to responded to ARP requests so that these address cannot be used as a way into your network or show up
on a port scan.
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IP pools and zones

Because IP pools are associated with individual interfaces IP pools cannot be set up for a zone. IP pools are
connected to individual interfaces.

Fixed Port

Some network configurations do not operate correctly if a NAT policy translates the source port of packets used
by the connection. NAT translates source ports to keep track of connections for a particular service.

However, enabling the use of a fixed port means that only one connection can be supported through the firewall
for this service. To be able to support multiple connections, add an IP pool, and then select Dynamic IP pool in
the policy. The firewall randomly selects an IP address from the IP pool and assigns it to each connection. In this
case, the number of connections that the firewall can support is limited by the number of IP addresses in the IP
pool.

Match-VIP

The match-vip feature allows the FortiGate unit to log virtual IP traffic that gets implicitly dropped. This feature
eliminates the need to create two policies for virtual IPs; one that allows the virtual IP, and the other to get proper
log entry for DROP rules.

For example, you have a virtual IP security policy and enabled the match-vip feature; the virtual IP traffic that is
not matched by the policy is now caught.

The match-vip feature is available only in the CLI. By default, the feature is disabled.

Services and TCP ports
There are a number of different services and protocols in use on the Internet. The most commonly known is
HTTPwhich is used by web servers to transmit requests and responses for unencrypted web pages. These
services are set up to listen for requests on a numbered port. These services and protocols can use any port from
1 to 65,535. To keep things simple for everyone a large number of the more commonly used services started
using a standardized list of ports. For instance, though it is not required, by default, most web servers listen for
HTTP requests on port 80 and by default, web browsers will send HTTP traffic to port 80. If you wish to use
another port such as 8080 you would put “:8080” at the end of the URL to indicate that you want the browser to
use 8080 instead of the default port.

Example

Default URL for HTTP traffic when the web server is listening on the standard HTTP port:

http://fortinet.com

URL to the same address when the web server is listening for HTTP traffic on port 8080

http://fortinet.com:8080

Services represent typical traffic types and application packets that pass through the FortiGate unit. Firewall
services define one or more protocols and port numbers associated with each service. Security policies use
service definitions to match session types. You can organize related services into service groups to simplify your
security policy list.
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Many well-known traffic types have been predefined on the FortiGate unit. If there is a service that does not
appear on the list you can create a service or edit an existing one. You need to know the ports, IP addresses or
protocols of that particular service or application uses, to create a service.

Best Practices

While you can edit a predefined service it is best to leave those ones alone and create
a new service and name it something similar such as the same service name with a
descriptive identifier appended.

Based on the previous example, instead of the name “HTTP” you could name the
service “HTTP8080” or use the application that is using that port, “HTTP-Application”.

Protocol Types

One of the fundamental aspects of a service is the type of protocol that use used to define it. When a service is
defined one of the following categories of protocol needs to be determined:

l TCP/UDP/SCTP
l ICMP
l ICMPv6
l IP

Depending on which of these protocol categories is choose another set of specifications will can also be defined.

Protocol Type Related specifications

TCP/UDP/SCTP This is the most commonly used service protocol category. Once this category has
been selected the other available options to choose are an address, either IP or
FQDN, and the protocol and port number. The protocol will be TCP, UDP or SCTP.

ICMP or ICMP6 When ICMP or ICMP6 is chosen the available options are the ICMP Type and its
code.

IP When IP is the chosen protocol type the addition option is the Protocol Number.

TCP/UDP/SCTP

TCP

Transmission Control Protocol (TCP) is one of the core or fundamental protocols of the Internet. It is part of the
Transport Layer of the OSI Model. It is designed to provide reliable delivery of data from a program on one device
on the network or Internet to another program on another device on the network or Internet. TCP achieves its
reliability because it is a connection based protocol. TCP is stream-oriented. It transports streams of data reliably
and in order.

TCP establishes a prior connection link between the hosts before sending data. This is often referred to as the
handshake. Once the link is established the protocol uses checks to verify that the data transmitted. If an error
check fails the data is retransmitted. This makes sure that the data is getting to the destination error free and in
the correct order so that it can be put back together into a form that is identical to the way they were sent.
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TCP is configured more for reliability than for speed and because of this TCPwill likely be slower than a
connectionless protocol such as UDP. This is why TCP is generally not used for real time applications such as
voice communication or online gaming.

Some of the applications that use TCP are:

l World Wide Web (HTTP and HTTPS)
l Email (SMTP, POP3, IMAP4)
l Remote administration (RDP)
l File transfer (FTP)

UDP

User Datagram Protocol (UDP) like TCP is one of the core protocols of the Internet and part of the Transport
Layer of the OSI Model. UDP is designed more for speed than reliability and is generally used for different
applications than TCP. UDP sends messages, referred to as datagrams across the network or Internet to other
hosts without establishing a prior communication link. In other words, there is no handshake.

UDP is an unreliable service as the datagrams can arrive out of order, duplicated or go missing without any
mechanism to verify them. UDPworks on the assumption that any error checking is done by the application or is
not necessary for the function of the application. This way it avoids the overhead that is required to verify the
integrity of the data.

This lack of overhead improves the speed of the data transfer and is why UDP is often used by applications that
are time sensitive in nature. UDP's stateless nature is also great for applications that answer a large number of
small queries from a large number of clients.

Common uses for UDP are:

l Domain Name Resolution (DNS)
l Time (NTP)
l Streaming media (RTSP, RTP and RTCP)
l Telephone of the Internet (VoIP)
l File Transfer (TFTP)
l Logging (SNMP)
l Online games (GTP and OGP)

SCTP

Stream Control Transmission Protocol (SCTP) is part of the Transport Layer of the OSI Model just like TCP and
UDP and provides some of the features of both of those protocols. It is message or datagram orientated like UDP
but it also ensures reliable sequential transport of data with congestion control like TCP.

SCTP provides the following services:

l Acknowledged error-free non-duplicated transfer of user data
l Data fragmentation to conform to discovered path MTU size
l Sequenced delivery of user messages within multiple streams, with an option for order-of-arrival delivery of

individual user messages
l Optional bundling of multiple user messages into a single SCTP packet
l Network-level fault tolerance through supporting of multi-homing at either or both ends of an association
l Congestion avoidance behavior and resistance to flooding and masquerade attacks
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SCTP uses multi-streaming to transport its messages which means that there can be several independent
streams of messages traveling in parallel between the points of the transmission. The data is sent out in larger
chunks of data than is used by TCP just like UDP but the messages include a sequence number within each
message in the same way that TCP does so that the data can be reassembled at the other end of the
transmission in the correct sequence without the data having to arrive in the correct sequence.

SCTP is effective as the transport protocol for applications that require monitoring and session-loss detection. For
such applications, the SCTP path and session failure detection mechanisms actively monitor the connectivity of
the session. SCTP differs from TCP in having multi-homing capabilities at either or both ends and several
streams within a connection, typically referred to as an association. A TCP stream represents a sequence of
bytes; an SCTP stream represents a sequence of messages.

Some common applications of SCTP include supporting transmission of the following protocols over IP networks:

l SCTP is important in 3G and 4G/LTE networks (for example, HomeNodeB = FemtoCells)
l SS7 over IP (for example, for 3G mobile networks)
l SCTP is also defined and used for SIP over SCTP and H.248 over SCTP
l Transport of Public Switched Telephone Network (PSTN) signaling messages over IP networks.

SCTP is a much newer protocol. It was defined by the IETF Signaling Transport (SIGTRAN) working group in
2000. It was introduced by RFC 3286 and more fully define by RFC 4960.

The FortiGate firewall can apply security policies to SCTP sessions in the same way as TCP and UDP sessions.
You can create security policies that accept or deny SCTP traffic by setting the service to “ALL”. FortiOS does not
include pre-defined SCTP services. To configure security policies for traffic with specific SCTP source or
destination ports you must create custom firewall services for SCTP.

FortiGate units route SCTP traffic in the same way as TCP and UDP traffic. You can configure policy routes
specifically for routing SCTP traffic by setting the protocol number to 132. SCTP policy routes can route SCTP
traffic according to the destination port of the traffic if you add a port range to the policy route.

You can configure a FortiGate unit to perform stateful inspection of different types of SCTP traffic by creating
custom SCTP services and defining the port numbers or port ranges used by those services. FortiGate units
support SCTP over IPv4. The FortiGate unit performs the following checks on SCTP packets:

l Source and Destination Port and Verification Tag.
l Chunk Type, Chunk Flags and Chunk Length
l Verify that association exists
l Sequence of Chunk Types (INIT, INIT ACK, etc)
l Timer checking
l Four way handshake checking
l Heartbeat mechanism
l Protection against INIT/ACK flood DoS attacks, and long-INIT flooding
l Protection against association hijacking

FortiOS also supports SCTP sessions over IPsec VPN tunnels, as well as full traffic and event logging for SCTP
sessions.

Protocol Port Values

The source and destination ports for TCP/UDP/SCTP services are important to get correct. If they are reversed
the service will not work. The destination port(s) are the on ones that refer to the ports that the computer will be
listening on. These are the port numbers that most people are familiar with when they associate a port number to
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a protocol. In most cases the source port will be one that is randomly assigned by the computer that is not being
already used by another service.

Most people associate HTTPwith port 80. This means that a web-server will be listening on port 80 for any http
requests being sent to the computer. The computer that is sending the request can use any port that is not
already assigned to another service or communication session. There are 65,535 ports that it can randomly
assign, but because the ports from 1 to 1024 are normally used for listening for incoming communications it is
usually not in that range. It is unless there is a specific instance when you know that a communication will be
coming from a predefined source port it is best practice to set the source port range from 1 to 65,535.

ICMP

The Internet Control Message Protocol (ICMP) is a protocol layered onto the Internet Protocol Suite to provide
error reporting flow control and first-hop gateway redirection. It is normally used by the operating systems of
networked computers to send connectivity status query, response and error messages. It is assigned protocol
number 1. There is a separate version of the protocol for both IPv4 and for IPv6. It is not designed to be
absolutely reliable like TCP.

ICMP is not typically used for transporting data or for end-user network applications with the exception of some
diagnostic utilities such as ping and traceroute.

ICMPmessages are sent in several situations, for example:

l when a datagram cannot reach its destination,
l time exceeded messages
l redirect messages
l when the gateway does not have the buffering capacity to forward a datagram
l when the gateway can direct the host to send traffic on a shorter route.

Some of the specific ICMPmessage types are:

l ICMP_ECHO
l ICMP_TIMESTAMP
l ICMP_INFO_REQUEST
l ICMP_ADDRESS

For ICMP error messages, only those reporting an error for an existing session can pass through the firewall. The
security policy will allow traffic to be routed, forwarded or denied. If allowed, the ICMP packets will start a new
session. Only ICMP error messages of a corresponding security policy is available will be sent back to the source.
Otherwise, the packet is dropped. That is, only ICMP packets for a corresponding security policy can traverse the
FortiGate unit.

ICMP Types and Codes

ICMP has a number of messages that are identified by the “Type” field. Some of these types have assigned
“Code” fields as well. The table below shows the different types of ICMP Types with their associated codes if
there are any.
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ICMP Types and Codes

Type Number Type Name Optional Code(s)

0 Echo Reply

1 Unassigned

2 Unassigned

3 Destination
Unreachable

0 Net Unreachable

1 Host Unreachable

2 Protocol Unreachable

3 Port Unreachable

4 Fragmentation Needed and Don't Fragment was Set

5 Source Route Failed

6 Destination Network Unknown

7 Destination Host Unknown

8 Source Host Isolated

9 Communication with Destination Network is Administratively
Prohibited

10 Communication with Destination Host is Administratively
Prohibited

11 Destination Network Unreachable for Type of Service

12 Destination Host Unreachable for Type of Service

13 Communication Administratively Prohibited

14 Host Precedence Violation

15 Precedence cutoff in effect

4 Source Quench
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Type Number Type Name Optional Code(s)

5 Redirect

0 Redirect Datagram for the Network (or subnet)

1 Redirect Datagram for the Host

2 Redirect Datagram for the Type of Service and Network

3 Redirect Datagram for the Type of Service and Host

6 Alternate Host
Address

7 Unassigned

8 Echo

9 Router
Advertisement

10 Router Selection

11 Time Exceeded
0 Time to Live exceeded in Transit

1 Fragment Reassembly Time Exceeded

12 Parameter Problem 0 Pointer indicates the error

1 Missing a Required Option

2 Bad Length

13 Timestamp

14 Timestand Reply

15 Information
Request

16 Information Reply

17 Address Mask
Request

18 Address Mask
Reply

19 Reserved (for
Security)

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

993



Firewall concepts Chapter 9 - Firewall

Type Number Type Name Optional Code(s)

20 - 29 Reserved (for
Robustness
Experiment)

30 Traceroute

31 Datagram
Conversion Error

32 Mobile Host
Redirect

33 IPv6 Where-Are-
You

34 IPv6 I-Am-Here

35 Mobile Registration

36 Mobile Registration
Reply

37 Domain Name
Request

38 Domain Name
Reply

39 SKIP

40 Photuris

41 - 255 Reserved

log-invalid-packet

The log-invalid-packet CLI setting is one that is intended to log invalid ICMP packets. The exact
definition being:

If the FortiGate unit receives an ICMP error packet that contains an embedded IP(A,B)|TCP (C,D)
header, then if FortiOS can locate the A:C -> B:D session it checks to make sure that the sequence
number in the TCP header is within the range recorded in the session. If the sequence number is not in
range then the ICMP packet is dropped.

When this field is enabled, the FortiGate also log messages that are not ICMP error packets.
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Types of logs covered by log-invalid-packet

l Invalid ICMP
l If ICMP error message verification (see "check-reset-range") is enabled

l Invalid DNS packets
l DNS packets that contain requests for non-existing domains

l iprope check failed
l reverse path check fail
l denied and broadcast traffic
l no session matched

Some other examples of messages that are not errors that will be logged, based on RFC792:

Type 3 messages correspond to "Destination Unreachable Message"

l Type 3, Code 1 = host unreachable
l Type 3, Code 3 = port unreachable

Type 11 messages correspond to "Time Exceeded Message"

l Type 11, Code 0 = time to live exceeded in transit

ICMPv6

Internet Control Message Protocol version 6 (ICMPv6) is the new implementation of the Internet Control
Message Protocol (ICMP) that is part of Internet Protocol version 6 (IPv6). The ICMPv6 protocol is defined in RFC
4443.

ICMPv6 is a multipurpose protocol. It performs such things as:

l error reporting in packet processing
l diagnostic functions
l Neighbor Discovery process
l IPv6 multicast membership reporting

It also designed as a framework to use extensions for use with future implementations and changes.

Examples of extensions that have already been written for ICMPv6:

l Neighbor Discovery Protocol (NDP) - a node discovery protocol in IPv6 which replaces and enhances functions of
ARP.

l Secure Neighbor Discovery Protocol (SEND) - an extension of NDPwith extra security.
l Multicast Router Discovery (MRD) - allows discovery of multicast routers.

ICMPv6 messages use IPv6 packets for transportation and can include IPv6 extension headers. ICMPv6 includes
some of the functionality that in IPv4 was distributed among protocols such as ICMPv4, ARP (Address Resolution
Protocol), and IGMP (Internet Group Membership Protocol version 3).

ICMPv6 has simplified the communication process by eliminating obsolete messages.

ICMPv6 messages are subdivided into two classes: error messages and information messages.

Error Messages are divided into four categories:

1. Destination Unreachable
2. Time Exceeded
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3. Packet Too Big
4. Parameter Problems
Information messages are divided into three groups:

1. Diagnostic messages
2. Neighbor Discovery messages
3. Messages for the management of multicast groups.

ICMPv6 Types and Codes

ICMPv6 has a number of messages that are identified by the “Type” field. Some of these types have assigned
“Code” fields as well. The table below shows the different types of ICMP Types with their associated codes if
there are any.

Type codes 0 − 127 are error messages and type codes 128 − 255 are for information messages.

Type Number Type Name Code

0 Reserved 0 - no route to destination

1 - communication with destination administratively prohibited

2 - beyond scope of source address

3 - address unreachable

4 - port unreachable

5 - source address failed ingress/egress policy

6 - reject route to destination

7 - Error in Source Routing Header

1 Destination
Unreachable

2 Packet Too Big

3 Time Exceeded
0 - hop limit exceeded in transit

1 - fragment reassembly time exceeded

4 Parameter Problem 0 - erroneous header field encountered

1 - unrecognized Next Header type encountered

2 - unrecognized IPv6 option encountered

ICMPv6 Types and Codes
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Type Number Type Name Code

100 Private
Experimentation

101 Private
Experimentation

102 - 126 Unassigned

127 Reserved for
expansion if
ICMPv6 error
messages

128 Echo Request

129 Echo Replay

130 Multicast Listener
Query

131 Multicast Listener
Report

132 Multicast Listener
Done

133 Router Solicitation

134 Router
Advertisement

135 Neighbor
Solicitation

136 Neighbor
Advertisement

137 Redirect Message

138 Router
Renumbering

0 - Router Renumbering Command

1 - Router Renumbering Result

255 - Sequence Number Reset
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Type Number Type Name Code

139 ICMPNode
Information Query

0 - The Data field contains an IPv6 address which is the Subject
of this Query.

1 - The Data field contains a name which is the Subject of this
Query, or is empty, as in the case of a NOOP.

2 - The Data field contains an IPv4 address which is the Subject
of this Query. 

140

ICMPNode

Information
Response

0 - A successful reply. The Reply Data field may or may not be
empty.

1 - The Responder refuses to supply the answer. The Reply
Data field will be empty.

2 - The Qtype of the Query is unknown to the Responder. The
Reply Data field will be empty.

141 Inverse Neighbor
Discovery
Solicitation
Message

142

Inverse Neighbor
Discovery
Advertisement
Message

143 Version 2 Multicast
Listener Report

144
Home Agent
Address Discovery
Request Message

145 Home Agent
Address Discovery
Reply Message

146 Mobile Prefix
Solicitation

147 Mobile Prefix
Advertisement

148
Certification Path
Solicitation
Message
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Type Number Type Name Code

149 Certification Path
Advertisement
Message

150

ICMPmessages
utilized by
experimental
mobility protocols
such as Seamoby

151 Multicast Router
Advertisement

152 Multicast Router
Solicitation

153 Multicast Router
Termination

154 FMIPv6 Messages

155 RPL Control
Message

156 ILNPv6 Locator
Update Message

157 Duplicate Address
Request

158 Duplicate Address
Confirmation

159 − 199 Unassigned

200 Private
experimentation

201 Private
experimentation

255

Reserved for
expansion of
ICMPv6
informational
messages
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IP

Internet Protocol (IP) is the primary part of the Network Layer of the OSI Model that is responsible for routing
traffic across network boundaries. It is the protocol that is responsible for addressing. IPv4 is probable the version
that most people are familiar with and it has been around since 1974. IPv6 is its current successor and due to a
shortage of available IPv4 addresses compared to the explosive increase in the number of devices that use IP
addresses, IPv6 is rapidly increasing in use.

When IP is chosen as the protocol type the available option to further specify the protocol is the protocol number.
This is used to narrow down which protocol within the Internet Protocol Suite and provide a more granular control.

Protocol Number

IP is responsible for more than the address that it is most commonly associated with and there are a number of
associated protocols that make up the Network Layer. While there are not 256 of them, the field that identifies
them is a numeric value between 0 and 256.

In the Internet Protocol version 4 (IPv4) [RFC791] there is a field called “Protocol” to identify the next level
protocol. This is an 8 bit field. In Internet Protocol version 6 (IPv6) [RFC2460], this field is called the “Next
Header” field.

Protocol Numbers

# Protocol Protocol's Full Name

0 HOPOPT IPv6 Hop-by-Hop Option

1 ICMP Internet Control Message Protocol

2 IGMP Internet Group Management

3 GGP Gateway-to-Gateway

4 IPv4 IPv4 encapsulation Protocol

5 ST Stream

6 TCP Transmission Control Protocol

7 CBT CBT

8 EGP Exterior Gateway Protocol

9 IGP Any private interior gateway (used by Cisco for their IGRP)

10 BBN-RCC-MON BBN RCCMonitoring

11 NVP-II Network Voice Protocol

12 PUP PUP
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# Protocol Protocol's Full Name

13 ARGUS ARGUS

14 EMCON EMCON

15 XNET Cross Net Debugger

16 CHAOS Chaos

17 UDP User Datagram Protocol

18 MUX Multiplexing

19 DCN-MEAS DCNMeasurement Subsystems

20 HMP Host Monitoring

21 PRM Packet Radio Measurement

22 XNS-IDP XEROXNS IDP

23 TRUNK-1 Trunk-1

24 TRUNK-2 Trunk-2

25 LEAF-1 Leaf-1

26 LEAF-2 Leaf-2

27 RDP Reliable Data Protocol

28 IRTP Internet Reliable Transaction

29 ISO-TP4 ISO Transport Protocol Class 4

30 NETBLT Bulk Data Transfer Protocol

31 MFE-NSP MFENetwork Services Protocol

32 MERIT-INP MERIT Internodal Protocol

33 DCCP Datagram Congestion Control Protocol

34 3PC Third Party Connect Protocol

35 IDPR Inter-Domain Policy Routing Protocol

36 XTP XTP
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# Protocol Protocol's Full Name

37 DDP Datagram Delivery Protocol

38 IDPR-CMTP IDPR Control Message Transport Proto

39 TP++ TP++ Transport Protocol

40 IL IL Transport Protocol

41 IPv6 IPv6 encapsulation

42 IPv6 SDRPSource Demand Routing Protocol

43 IPv6-Route Routing Header for IPv6

44 IPv6-Frag Fragment Header for IPv6

45 IDRP Inter-Domain Routing Protocol

46 RSVP Reservation Protocol

47 GRE General Routing Encapsulation

48 DSR Dynamic Source Routing Protocol

49 BNA BNA

50 ESP Encap Security Payload

51 AH Authentication Header

52 I-NLSP Integrated Net Layer Security TUBA

53 SWIPE IP with Encryption

54 NARP NBMAAddress Resolution Protocol

55 MOBILE IPMobility

56 TLSP Transport Layer Security Protocol using Kryptonet key
management

57 SKIP SKIP

58 IPv6-ICMP ICMP for IPv6

59 IPv6-NoNxt No Next Header for IPv6

60 IPv6-Opts Destination Options for IPv6
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# Protocol Protocol's Full Name

61 any host internal protocol

62 CFTP CFTP

63 any local network

64 SAT-EXPAK SATNET and Backroom EXPAK

65 KRYPTOLAN Kryptolan

66 RVD MIT Remote Virtual Disk Protocol

67 IPPC Internet Pluribus Packet Core

68 any distributed file system

69 SAT-MON SATNET Monitoring

70 VISA VISA Protocol

71 IPCV Internet Packet Core Utility

72 CPNX Computer Protocol Network Executive

73 CPHB Computer Protocol Heart Beat

74 WSN Wang Span Network

75 PVP Packet Video Protocol

76 BR-SAT-MON Backroom SATNET Monitoring

77 SUN-ND SUN ND PROTOCOL-Temporary

78 WB-MON WIDEBANDMonitoring

79 WB-EXPAK WIDEBAND EXPAK

80 ISO-IP ISO Internet Protocol

81 VMTP VMTP

82 SECURE-VMTP SECURE-VMTP

83 VINES VINES

84 TTP TTP
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# Protocol Protocol's Full Name

84 IPTM Protocol Internet Protocol Traffic

85 NSFNET-IGP NSFNET-IGP

86 DGP Dissimilar Gateway Protocol

87 TCF TCF

88 EIGRP EIGRP

89 OSPFIGP OSPFIGP

90 Sprite-RPC Sprite RPC Protocol

91 LARP Locus Address Resolution Protocol

92 MTP Multicast Transport Protocol

93 AX.25 AX.25 Frames

94 IPIP IP-within-IP Encapsulation Protocol

95 MICP Mobile Internetworking Control Pro.

96 SCC-SP Semaphore Communications Sec. Pro.

97 ETHERIP Ethernet-within-IP Encapsulation

98 ENCAP Encapsulation Header

99 any private encryption scheme

100 GMTP GMTP

101 IFMP Ipsilon Flow Management Protocol

102 PNNI PNNI over IP

103 PIM Protocol Independent Multicast

104 ARIS ARIS

105 SCPS SCPS

106 QNX QNX

107 A/N Active Networks
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# Protocol Protocol's Full Name

108 IPComp IP Payload Compression Protocol

109 SNP Sitara Networks Protocol

110 Compaq-Peer Compaq Peer Protocol

111 IPX-in-IP IPX in IP

112 VRRP Virtual Router Redundancy Protocol

113 PGM PGM Reliable Transport Protocol

114 any 0-hop protocol

115 L2TP Layer Two Tunneling Protocol

116 DDX D-II Data Exchange (DDX)

117 IATP Interactive Agent Transfer Protocol

118 STP Schedule Transfer Protocol

119 SRP SpectraLink Radio Protocol

120 UTI UTI

121 SMP Simple Message Protocol

122 SM SM

123 PTP Performance Transparency Protocol

124 ISIS over IPv4

125 FIRE

126 CRTP Combat Radio Transport Protocol

127 CRUDP Combat Radio User Datagram

128 SSCOPMCE

129 IPLT

130 SPS Secure Packet Shield

131 PIPE Private IP Encapsulation within IP
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# Protocol Protocol's Full Name

132 SCTP Stream Control Transmission Protocol

133 FC Fibre Channel

134 RSVP-E2E-
IGNORE

135 Mobility Header

136 UDPLite

137 MPLS-in-IP

138 manet

139 HIP

140 Shim6

141 WESP

142 ROHC

143 − 252 Unassigned Unassigned

253 Use for experimentation and testing

254 Use for experimentation and testing

255 Reserved

Further information can be found by researching RFC 5237.

Protocol Number

IP is responsible for more than the address that it is most commonly associated with and there are a number of
associated protocols that make up the Network Layer. While there are not 256 of them, the field that identifies
them is a numeric value between 0 and 256.

In the Internet Protocol version 4 (IPv4) [RFC791] there is a field called “Protocol” to identify the next level
protocol. This is an 8 bit field. In Internet Protocol version 6 (IPv6) [RFC2460], this field is called the “Next
Header” field.

Protocol Numbers

# Protocol Protocol's Full Name

0 HOPOPT IPv6 Hop-by-Hop Option
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# Protocol Protocol's Full Name

1 ICMP Internet Control Message Protocol

2 IGMP Internet Group Management

3 GGP Gateway-to-Gateway

4 IPv4 IPv4 encapsulation Protocol

5 ST Stream

6 TCP Transmission Control Protocol

7 CBT CBT

8 EGP Exterior Gateway Protocol

9 IGP Any private interior gateway (used by Cisco for their IGRP)

10 BBN-RCC-MON BBN RCCMonitoring

11 NVP-II Network Voice Protocol

12 PUP PUP

13 ARGUS ARGUS

14 EMCON EMCON

15 XNET Cross Net Debugger

16 CHAOS Chaos

17 UDP User Datagram Protocol

18 MUX Multiplexing

19 DCN-MEAS DCNMeasurement Subsystems

20 HMP Host Monitoring

21 PRM Packet Radio Measurement

22 XNS-IDP XEROXNS IDP

23 TRUNK-1 Trunk-1

24 TRUNK-2 Trunk-2
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# Protocol Protocol's Full Name

25 LEAF-1 Leaf-1

26 LEAF-2 Leaf-2

27 RDP Reliable Data Protocol

28 IRTP Internet Reliable Transaction

29 ISO-TP4 ISO Transport Protocol Class 4

30 NETBLT Bulk Data Transfer Protocol

31 MFE-NSP MFENetwork Services Protocol

32 MERIT-INP MERIT Internodal Protocol

33 DCCP Datagram Congestion Control Protocol

34 3PC Third Party Connect Protocol

35 IDPR Inter-Domain Policy Routing Protocol

36 XTP XTP

37 DDP Datagram Delivery Protocol

38 IDPR-CMTP IDPR Control Message Transport Proto

39 TP++ TP++ Transport Protocol

40 IL IL Transport Protocol

41 IPv6 IPv6 encapsulation

42 IPv6 SDRPSource Demand Routing Protocol

43 IPv6-Route Routing Header for IPv6

44 IPv6-Frag Fragment Header for IPv6

45 IDRP Inter-Domain Routing Protocol

46 RSVP Reservation Protocol

47 GRE General Routing Encapsulation

48 DSR Dynamic Source Routing Protocol
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# Protocol Protocol's Full Name

49 BNA BNA

50 ESP Encap Security Payload

51 AH Authentication Header

52 I-NLSP Integrated Net Layer Security TUBA

53 SWIPE IP with Encryption

54 NARP NBMAAddress Resolution Protocol

55 MOBILE IPMobility

56 TLSP Transport Layer Security Protocol using Kryptonet key
management

57 SKIP SKIP

58 IPv6-ICMP ICMP for IPv6

59 IPv6-NoNxt No Next Header for IPv6

60 IPv6-Opts Destination Options for IPv6

61 any host internal protocol

62 CFTP CFTP

63 any local network

64 SAT-EXPAK SATNET and Backroom EXPAK

65 KRYPTOLAN Kryptolan

66 RVD MIT Remote Virtual Disk Protocol

67 IPPC Internet Pluribus Packet Core

68 any distributed file system

69 SAT-MON SATNET Monitoring

70 VISA VISA Protocol

71 IPCV Internet Packet Core Utility

72 CPNX Computer Protocol Network Executive

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1009



Firewall concepts Chapter 9 - Firewall

# Protocol Protocol's Full Name

73 CPHB Computer Protocol Heart Beat

74 WSN Wang Span Network

75 PVP Packet Video Protocol

76 BR-SAT-MON Backroom SATNET Monitoring

77 SUN-ND SUN ND PROTOCOL-Temporary

78 WB-MON WIDEBANDMonitoring

79 WB-EXPAK WIDEBAND EXPAK

80 ISO-IP ISO Internet Protocol

81 VMTP VMTP

82 SECURE-VMTP SECURE-VMTP

83 VINES VINES

84 TTP TTP

84 IPTM Protocol Internet Protocol Traffic

85 NSFNET-IGP NSFNET-IGP

86 DGP Dissimilar Gateway Protocol

87 TCF TCF

88 EIGRP EIGRP

89 OSPFIGP OSPFIGP

90 Sprite-RPC Sprite RPC Protocol

91 LARP Locus Address Resolution Protocol

92 MTP Multicast Transport Protocol

93 AX.25 AX.25 Frames

94 IPIP IP-within-IP Encapsulation Protocol

95 MICP Mobile Internetworking Control Pro.
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# Protocol Protocol's Full Name

96 SCC-SP Semaphore Communications Sec. Pro.

97 ETHERIP Ethernet-within-IP Encapsulation

98 ENCAP Encapsulation Header

99 any private encryption scheme

100 GMTP GMTP

101 IFMP Ipsilon Flow Management Protocol

102 PNNI PNNI over IP

103 PIM Protocol Independent Multicast

104 ARIS ARIS

105 SCPS SCPS

106 QNX QNX

107 A/N Active Networks

108 IPComp IP Payload Compression Protocol

109 SNP Sitara Networks Protocol

110 Compaq-Peer Compaq Peer Protocol

111 IPX-in-IP IPX in IP

112 VRRP Virtual Router Redundancy Protocol

113 PGM PGM Reliable Transport Protocol

114 any 0-hop protocol

115 L2TP Layer Two Tunneling Protocol

116 DDX D-II Data Exchange (DDX)

117 IATP Interactive Agent Transfer Protocol

118 STP Schedule Transfer Protocol

119 SRP SpectraLink Radio Protocol
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# Protocol Protocol's Full Name

120 UTI UTI

121 SMP Simple Message Protocol

122 SM SM

123 PTP Performance Transparency Protocol

124 ISIS over IPv4

125 FIRE

126 CRTP Combat Radio Transport Protocol

127 CRUDP Combat Radio User Datagram

128 SSCOPMCE

129 IPLT

130 SPS Secure Packet Shield

131 PIPE Private IP Encapsulation within IP

132 SCTP Stream Control Transmission Protocol

133 FC Fibre Channel

134 RSVP-E2E-
IGNORE

135 Mobility Header

136 UDPLite

137 MPLS-in-IP

138 manet

139 HIP

140 Shim6

141 WESP

142 ROHC

143 − 252 Unassigned Unassigned
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# Protocol Protocol's Full Name

253 Use for experimentation and testing

254 Use for experimentation and testing

255 Reserved

Further information can be found by researching RFC 5237.

VPN Policies
At one point, if you wanted to have secure digital communications between 2 points a private network would be
created. This network would only allow the people that were intended to get the communications on it. This is
very straightforward if the 2 points are in the same room or even in the same building. It can all be done
physically. If you are supposed to be on the secure network

VPNs are an answer to one of today’s biggest concerns, how to make digital communications secure between to
points that must communicate over the Internet which anybody can have access to.

There are two types of VPNs supported by FortiOS, SSL and IPsec. They are differentiated by the security
protocol suites that are used to secure the traffic. These are both described in more detail in the VPN section, but
the IPsec VPN can be configured as an Action with a firewall policy.

IPsec Policies

IPsec policies allow IPsec VPN traffic access to the internal network from a remote location. These policies
include authentication information that authenticates users and user group or groups. These policies specify the
following:

l the FortiGate firewall interface that provides the physical connection to the remote VPN gateway, usually an
interface connected to the Internet

l the FortiGate firewall interface that connects to the private network
l IP addresses associated with data that has to be encrypted and decrypted
l optional: a schedule that restricts when the VPN can operate, and services (or types of data) that can be sent.

For a route-based (interface mode) VPN, you do not configure an IPsec security policy. Instead, you configure two
regular ACCEPT security policies, one for each direction of communication, with the IPsec virtual interface as the
source or destination interface, as appropriate.

DSRI
The Disable Server Response Inspection (DSRI) options is available for configuration in the CLI. This is used to
assist performance when only URL filtering is being used. This allows the system to ignore the HTTP server
responses. The setting is configured to be disabled by default.

CLI syntax for changing the status of the DSRI setting

In IPv4 or IPv6 firewall policies

config firewall policy|policy6
edit 0
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set dsri enable|disable
end

In IPv4 or IPv6 interface policies

config firewall interface-policy|interface-policy6
edit 0

set dsri enable|disable
end

When using the sniffer

config firewall sniffer
edit 0

set dsri enable|disable
end

Interface Policies
Interface policies are implemented before the “security” policies and are only flow based. They are configured in
the CLI.

This feature allows you to attach a set of IPS policies with the interface instead of the forwarding path, so packets
can be delivered to IPS before entering firewall. This feature is used for following IPS deployments:

l One-Arm: by defining interface policies with IPS and DoS anomaly checks and enabling sniff-mode on the interface,
the interface can be used for one-arm IDS;

l IPv6 IPS: IPS inspection can be enabled through interface IPv6 policy. Only IPS signature scan is supported in
FortiOS 4.0. IPv6 DoS protection is not supported;

l Scan traffics that destined to FortiGate;
l Scan and log traffics that are silently dropped or flooded by Firewall or Multicast traffic.

IPS sensors can be assigned to an interface policy. Both incoming and outgoing packets are inspected by IPS
sensor (signature).

Here is an example of an interface policy,

# show full-configuration

config firewall interface-policy
edit 1

set status enable
set comments 'test interface policy #1'
set logtraffic utm
set interface "port9"
set srcaddr "all"
set dstaddr "all"
set service "ALL"
set application-list-status disable
set ips-sensor-status disable
set dsri disable
set av-profile-status enable
set av-profile "default"
set webfilter-profile-status disable
set spamfilter-profile-status disable
set dlp-sensor-status disable
set scan-botnet-connections disable
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next
end

DoS Protection
Denial of Service (DoS) policies are primarily used to apply DoS anomaly checks to network traffic based on the
FortiGate interface it is entering as well as the source and destination addresses. DoS checks are a traffic
anomaly detection feature to identify network traffic that does not fit known or common traffic patterns and
behavior. A common example of anomalous traffic is the denial of service attack. A denial of service occurs when
an attacking system starts an abnormally large number of sessions with a target system. The large number of
sessions slows down or disables the target system, so that legitimate users can no longer use it.

DoS policies are similar to firewall policies except that instead of defining the way traffic is allowed to flow, they
keep track of certain traffic patterns and attributes and will stop traffic displaying those attributes. Further, DoS
policies affect only incoming traffic on a single interface. You can further limit a DoS policy by source address,
destination address, and service.

DoS configurations have been changed a couple of times in the past. In FortiOS 4.0, DoS protection is moved to
the interface policy, so when it is enabled, it is the first thing checked when a packet enters FortiGate. Because of
this early detection, DoS policies are a very efficient defense that uses few resources. Denial of service attacks,
for example, are detected and its packets dropped before requiring security policy look-ups, antivirus scans, and
other protective but resource-intensive operations.

A DoS policy examines network traffic arriving at an interface for anomalous patterns usually indicating an attack.
This does not mean that all anomalies experience by the firewall are the result of an intentional attack.

Because an improperly configured DoS anomaly check can interfere with network traffic, no DoS checks are
preconfigured on a factory default FortiGate unit. You must create your own before they will take effect.
Thresholds for newly created sensors are preset with recommended values that you can adjust to meet the needs
of your network.

To create a Denial of Service policy determine if it needs to be an IPv4 or IPv6 policy, then go to:

Policy & Objects > IPv4 DoS Policy for IPv4.

Policy & Objects > IPv6 DoS Policy for IPv6.

The Enable SSH Deep Scan feature is enabled by default when creating a new
SSL/SSH Inspection profile. There are situations were this feature can cause issues so
be sure that you would like it enabled before applying it.

Settings used in configuring DoS

Incoming Interface

The interface to which this security policy applies. It will be the that the traffic is coming into the firewall on.

Source Address

This will be the address that the traffic is coming from and must be a address listed in the Address section of the
Firewall Objects. This can include the predefined “all” address which covers any address coming in on any
interface. Multiple addresses or address groups can be chosen
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Destination Address

This will be the address that the traffic is addressed to. In this case it must be an address that is associated with
the firewall itself. For instance it could be one of the interface address of the firewall, a secondary IP address or
the interface address assigned to a Virtual IP address. Just like with the Source Address this address must be
already configured before being used in the DoS policy. Multiple addresses, virtual IPs or virtual IP groups can be
chosen.

Service

While the Service field allows for the use of the ALL service some administrators prefer to optimize the resources
of the firewall and only check on the services that will be answered on an interface. Multiple services or service
groups can be chosen.

Anomalies

The anomalies can not be configured by the user. They are predefined sensors set up for specific patterns of
anomalous traffic

The anomalies that have been predefined for use in the DoS Policies are:

Anomaly Name Description Recommended Threshold

tcp_syn_flood

If the SYN packet rate of new TCP connections,
including retransmission, to one destination IP
address exceeds the configured threshold value, the
action is executed.

2000 packets per second.

tcp_port_scan

If the SYN packet rate of new TCP connections,
including retransmission, from one source IP address
exceeds the configured threshold value, the action is
executed.

1000 packets per second.

tcp_src_session
If the number of concurrent TCP connections from
one source IP address exceeds the configured
threshold value, the action is executed.

5000 concurrent sessions.

tcp_dst_session
If the number of concurrent TCP connections to one
destination IP address exceeds the configured
threshold value, the action is executed.

5000 concurrent sessions.

udp_flood
If the UDP traffic to one destination IP address
exceeds the configured threshold value, the action is
executed.

2000 packets per second.

udp_scan
If the number of UDP sessions originating from one
source IP address exceeds the configured threshold
value, the action is executed.

2000 packets per second.

udp_src_session
If the number of concurrent UDP connections from
one source IP address exceeds the configured
threshold value, the action is executed.

5000 concurrent sessions.
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Anomaly Name Description Recommended Threshold

udp_dst_session
If the number of concurrent UDP connections to one
destination IP address exceeds the configured
threshold value, the action is executed.

5000 concurrent sessions.

icmp_flood
If the number of ICMP packets sent to one
destination IP address exceeds the configured
threshold value, the action is executed.

250 packets per second.

icmp_sweep
If the number of ICMP packets originating from one
source IP address exceeds the configured threshold
value, the action is executed.

100 packets per second.

icmp_src_
session

If the number of concurrent ICMP connections from
one source IP address exceeds the configured
threshold value, the action is executed.

300 concurrent sessions

icmp_dst_
session

If the number of concurrent ICMP connections to one
destination IP address exceeds the configured
threshold value, the action is executed.

3000 concurrent sessions

ip_src_session
If the number of concurrent IP connections from one
source IP address exceeds the configured threshold
value, the action is executed.

5000 concurrent sessions.

ip_dst_session
If the number of concurrent IP connections to one
destination IP address exceeds the configured
threshold value, the action is executed.

5000 concurrent sessions.

sctp_flood
If the number of SCTP packets sent to one
destination IP address exceeds the configured
threshold value, the action is executed.

2000 packets per second

sctp_scan
If the number of SCTP sessions originating from one
source IP address exceeds the configured threshold
value, the action is executed.

1000 packets per second

sctp_src_session
If the number of concurrent SCTP connections from
one source IP address exceeds the configured
threshold value, the action is executed.

5000 concurrent sessions

sctp_dst_session
If the number of concurrent SCTP connections to
one destination IP address exceeds the configured
threshold value, the action is executed.

5000 concurrent sessions

Status

The status field is enabled to enable the sensor for the associated anomaly. In terms of actions performed there
is no difference between disabling a sensor and having the action as “Pass” but by disabling sensors that are not
being used for blocking or logging you can save some resources of the firewall that can be better used elsewhere.

Logging

Regardless of whether the traffic is blocked or passed through the anomalous traffic will be logged.
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Pass

Allows the anomalous traffic to pass through unimpeded.

Block

For Thresholds based on the number of concurrent sessions blocking the anomaly will not allow more than the
number of concurrent sessions set as the threshold.

For rate based thresholds where the threshold is measured in packets per second, the Action setting “Block”
prevents the overwhelming of the firewall by anomalous traffic in one of 2 ways. Setting which of those 2 ways will
be issued is determined in the CLI.

l continuous - blocks packets once an anomaly is detected. This overrides individual anomaly settings.
l periodical - allows matching anomalous traffic up to the rate set by the threshold.

If the period for a particular anomaly is 60 seconds, such as those where the threshold
is measured in concurrent sessions, after the 60 second timer has expired, the number
of allowed packets that match the anomaly criteria is reset to zero. This means that if
you allow 10 sessions through before blocking, after the 60 seconds is up, another 10
will be allowed. The attrition of sessions from expiration should keep the allowed
sessions from reaching the maximum.

To set the type of block action for the rate based anomaly sensors:

config ips global
set anomaly-mode continuous
set anomaly-mode periodical

end

Threshold

The threshold can be either in terms of concurrent session or in packets per second depending on which sensor is
being referred to.

Quarantine

The quarantine feature is found in the CLI. This setting is used to block any further traffic from a source address
that is now considered to be a malicious actor or a source of traffic dangerous to the network. Not only is no more
traffic accepted for the duration of the quanantine through the DoS policy but the source IP address of the traffic
is added to the banned source ip list.This list is kept in the kernal and used by

l Antivirus
l Data Leak Prevention (DLP)
l Denial of Service (DoS)
l Intrustion Prevention System (IPS)

Any policies that use any of these features will block traffic from the attacker's IP address.

Syntax

config firewall {DoS-policy|DoS-policy6}
edit <policyid>

set quarantine {none|attacker}
set quarantine-exipiry {string}
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set quarantine-log {enable|disable}
end

Option Description

quarantine Quarantine method.

l none - Quarantine is disabled.
l attacker - Block all traffic sent from the attacker's IP address. The

quarantined IP address is also added to the banned ip list. The
destination address is not affected.

quarantine-expiry

Duration of quarantine

The format is ###d##h##m, ranging from 1 minute to 364 days, 23 hours,
and 59 minutes starting from now. The default is 0d0h5m. Requires
quarantine set to attacker.

quarantine-log Enables or disables the logging of quarantine events.

One-Arm IDS

Interface-based policy only defines what and how IPS functions are applied to the packets transmitted by the
interface. It works no matter if the port is used in a forwarding path or used as an One-Arm device.

To enable One-Arm IDS, the user should first enable sniff-mode on the interface,

config system interface
edit port2

set ips-sniffer-mode enable
next

end

Once sniff-mode is turned on, both incoming and outgoing packets will be dropped after IPS inspections. The port
can be connected to a hub or a switch's SPAN port. Any packet picked up by the interface will still follow the
interface policy so different IPS and DoS anomaly checks can be applied.

IPv6 IPS

IPv6 IPS signature scan can be enabled by interface policy. The user can create an normal IPS sensor and assign
it to the IPv6 interface policy.

config firewall interface-policy6
edit 1

set interface "port1"
set srcaddr6 "all"
set dstaddr6 "all"
set service6 "ALL"
set ips-sensor-status enable
set ips-sensor "all_default"

next
end
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Traffic Destined to the FortiGate unit

IPS enabled in firewall policies can only inspect the traffic pass through FortiGate unit, not the traffic destined to
FortiGate unit. Enabling IPS in interface-policy allows IPS to pick up any packet on the interface so it is able to
inspect attacks targeting FGT.

Dropped, Flooded, Broadcast, Multicast and L2 packets

In many evaluation or certification tests, FortiGate firewall is often required to log any packets dropped by the
firewall. In most of cases, these packets are of invalid headers so firewall just drops them silently. It is natural to
forward all these packets to IPS first so FortiGate firewall is able to generate logs for invalid packets.

Flooded, broadcast and multicast traffics do not reach any of services in the forwarding path. They can be
inspected by the interface policy as long as they match the addresses defined. Potentially, L2 packets can also be
sent to IPS for inspection through interface-policy, but it is not enabled in FortiOS 4.0.

GUI and CLI

Now in FortiGate, there are two places that IPS can be enabled, in a firewall policy and in an interface policy. In
the firewall policy implementation, IPS sensor can be configured in both CLI and GUI. When adding an IPS
sensor to an interface policy it must be done through the CLI. There is no GUI input window for the “Interface
Policy”. There is however, a DoS Policy section in the GUI.

Local-In Policies
On the FortiGate unit, there are a number of protocols and traffic that is specific to the internal workings of
FortiOS. For many of these traffic sources, you can identify a specific port/IP address for this self-originating
traffic. The following traffic can be configured to a specific port/IP address:

l SNMP
l Syslog
l alert email
l FortiManager connection IP
l FortiGuard services
l FortiAnalyzer logging
l NTP
l DNS
l Authorization requests such as RADIUS
l FSSO

Security policies control the flow of traffic through the FortiGate unit. The FortiGate unit also includes the option
of controlling internal traffic, that is, management traffic.

Each interface includes an allow access configuration to allow management access for specific protocols. Local
policies are set up automatically to allow all users all access. Local-in policies takes this a step further, to enable
or restrict the user with that access. This also extends beyond the allow access selection.

Local-in policies are configured in the CLI with the commands:

config firewall local-in-policy
edit <policy_number>

set intf <source_interface>
set srcaddr <source_address>
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set dstaddr <destination_address>
set action {accept | deny}
set service <service name>
set schedule <schedule_name>

end

For example, you can configure a local-in policy so that only administrators can access the FortiGate unit on
weekends from a specific management computer at 192.168.21.12, represented by the address object mgmt-
comp1, using SSH on port 3 (192.168.21.77 represented by the address object FG-port3) using the Weekend
schedule which defines the time the of access.

config firewall local-in-policy
edit <1>

set intf port3
set srcaddr mgmt-comp1
set dstaddr FG-port3
set action accept
set service SSH
set schedule Weekend

end

You can also disable a policy should there be a requirement to turn off a policy for troubleshooting or other
purpose. To disable a policy enter the commands:

config firewall local-in-policy
edit <policy_number>

set status disable
end

Use the same commands with a status of enable to use the policy again.

It is also an option to dedicate the interface as HAmanagement interface by using the setting:

set ha-mgmt-intf-only enable

Local-in policies are also supported for IPv6 by entering the command:

config firewall local-in-policy6.

While there is a section under Policy & Objects for viewing the existing Local In
Policy configuration, policies cannot be created or edited here in the GUI. The Local
In polices can only be created or edited in the CLI.

Security Policy 0
Any security policy that is automatically added by the FortiGate unit has a policy ID number of zero (0). The most
common reasons the FortiGate unit creates this policy is:

l The IPsec policy for FortiAnalyzer (and FortiManager version 3.0) is automatically added when an IPsec connection
to the FortiAnalyzer unit or FortiManager is enabled.

l The policy to allow FortiGuard servers to be automatically added has a policy ID number of zero.
l The (default) drop rule that is the last rule in the policy and that is automatically added has a policy ID number of

zero.
l When a network zone is defined within a VDOM, the intra-zone traffic set to allow or block is managed by policy 0 if

it is not processed by a configured security policy.
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This policy can appear in logs but will never appear in the security policy list, and therefore, can never be
repositioned in the list.

When viewing the FortiGate firewall logs, you may find a log field entry indicating policyid=0. The following log
message example indicates the log field policyid=0 in bold.

2008-10-06 00:13:49 log_id=0022013001 type=traffic subtype=violation pri=warning
vd=root SN=179089 duration=0 user=N/A group=N/A rule=0 policyid=0 proto=17
service=137/udp app_type=N/A status=deny src=10.181.77.73 srcname=10.181.77.73
dst=10.128.1.161 dstname=10.128.1.161 src_int=N/A dst_int="Internal" sent=0 rcvd=0
src_port=137 dst_port=137 vpn=N/A tran_ip=0.0.0.0 tran_port=0

Deny Policies
Deny security policies deny traffic that is coming into the network. The FortiGate unit automatically blocks traffic
that is associated with a deny security policy.

Deny security policies are usually configured when you need to restrict specific traffic, for example, SSH traffic.
Deny security policies can also help when you want to block a service, such as DNS, but allow a specific DNS
server.

Accept Policies
Accept security policies accept traffic that is coming into the network. These policies allow traffic through the
FortiGate unit, where the packets are scanned, translated if NAT is enabled, and then sent out to its destination.

Accept security policies are the most common security policies that are created in FortiOS. These security
policies are basic policies, such as allowing Internet access, as well as complex policies, such as IPsec VPN.

Fixed Port
Some network configurations do not operate correctly if a NAT policy translates the source port of packets used
by the connection. NAT translates source ports to keep track of connections for a particular service.

From the CLI you can enable fixedport when configuring a security policy for NAT policies to prevent source port
translation.

config firewall policy
edit <policy-id>

...
set fixedport enable
...

end

However, enabling fixedport means that only one connection can be supported through the firewall for this
service. To be able to support multiple connections, add an IP pool, and then select Dynamic IP pool in the policy.
The firewall randomly selects an IP address from the IP pool and assigns it to each connection. In this case, the
number of connections that the firewall can support is limited by the number of IP addresses in the pool.

Endpoint Security
Endpoint security enforces the use of the FortiClient End Point Security (FortiClient and FortiClient Lite)
application on your network. It can also allow or deny endpoints access to the network based on the application
installed on them.
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By applying endpoint security to a security policy, you can enforce this type of security on your network.
FortiClient enforcement can check that the endpoint is running the most recent version of the FortiClient
application, that the antivirus signatures are up-to-date, and that the firewall is enabled. An endpoint is usually
often a single PC with a single IP address being used to access network services through a FortiGate unit.

With endpoint security enabled on a policy, traffic that attempts to pass through, the FortiGate unit runs
compliance checks on the originating host on the source interface. Non-compliant endpoints are blocked. If
someone is browsing the web, the endpoints are redirected to a web portal which explains the non-compliance
and provides a link to download the FortiClient application installer. The web portal is already installed on the
FortiGate unit, as a replacement message, which you can modify if required.

Endpoint Security requires that all hosts using the security policy have the FortiClient Endpoint Security agent
installed. Currently, FortiClient Endpoint Security is available for Microsoft Windows 2000 and later only.

For more information about endpoint security, see the Security Profiles chapter in the FortiOS Handbook.

Traffic Logging
When you enable logging on a security policy, the FortiGate unit records the scanning process activity that
occurs, as well as whether the FortiGate unit allowed or denied the traffic according to the rules stated in the
security policy. This information can provide insight into whether a security policy is working properly, as well as if
there needs to be any modifications to the security policy, such as adding traffic shaping for better traffic
performance.

Depending on what the FortiGate unit has in the way of resources, there may be advantages in optimizing the
amount of logging taking places. This is why in each policy you are given 3 options for the logging:

l Disable Log Allowed Traffic - Does not record any log messages about traffic accepted by this policy.

If you enable Log Allowed Traffic, the following two options are available:

l Security Events - This records only log messages relating to security events caused by traffic accepted by this
policy.

l All Sessions - This records all log messages relating to all of the traffic accepted by this policy.

Depending on the model, if the Log all Sessions option is selected there may be 2 additional options. These options
are normally available in the GUI on the higher end models such as the FortiGate 600C or larger.
l Generate Logs when Session Starts
l Capture Packets

You can also use the CLI to enter the following command to write a log message when a session starts:

config firewall policy
edit <policy-index>

set logtraffic-start
end

Traffic is logged in the traffic log file and provides detailed information that you may not think you need, but do.
For example, the traffic log can have information about an application used (web: HTTP.Image), and whether or
not the packet was SNAT or DNAT translated. The following is an example of a traffic log message.

2011-04-13
05:23:47
log_id=4
type=traffic
subtype=other
pri=notice
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vd=root
status="start"
src="10.41.101.20"
srcname="10.41.101.20"
src_port=58115
dst="172.20.120.100"
dstname="172.20.120.100"
dst_country="N/A"
dst_port=137
tran_ip="N/A"
tran_port=0
tran_sip="10.31.101.41"
tran_sport=58115
service="137/udp"
proto=17
app_type="N/A"
duration=0
rule=1
policyid=1
sent=0
rcvd=0
shaper_drop_sent=0
shaper_drop_rcvd=0
perip_drop=0
src_int="internal"
dst_int="wan1"
SN=97404 app="N/A"
app_cat="N/A"
carrier_ep="N/A"

If you want to know more about logging, see the Logging and Reporting chapter in the FortiOS Handbook. If you
want to know more about traffic log messages, see the FortiGate Log Message Reference.
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Network defense

This section describes in general terms the means by which attackers can attempt to compromise your network
using attacks at the network level rather than through application vulnerabilities, and steps you can take to protect
it. The goal of an attack can be as complex as gaining access to your network and the privileged information it
contains, or as simple as preventing customers from accessing your web server.

Because of popular media, many people are aware of viruses and other malware as a threat against their
computers and data, but some of the most costly malicious attack in history have been against networks. A 2016
study found that a single DDoS attack could cast a company over $1.6 million. Depending on the size and type of
company the areas of expense can be:

l Changes in credit and insurance ratings
l Overtime payment to employees
l Hiring new employees in increase IT staff
l PR expenses to restore a company's reputation
l Upgrading infrastructure and software
l Customer compensation

The following topics are included in this section:

l Monitoring
l Blocking external probes
l Defending against DoS attacks

Monitoring
Monitoring, in the form of logging, alert email, and SNMP, does not directly protect your network. But monitoring
allows you to review the progress of an attack, whether afterwards or while in progress. How the attack unfolds
may reveal weaknesses in your preparations. The packet archive and sniffer policy logs can reveal more details
about the attack. Depending on the detail in your logs, you may be able to determine the attackers location and
identity.

While log information is valuable, you must balance the log information with the resources required to collect and
store it.

Blocking external probes
Protection against attacks is important, but attackers often use vulnerabilities and network tools to gather
information about your network to plan an attack. It is often easier to prevent an attacker from learning important
details about your network than to defend against an attack designed to exploit your particular network.

Attacks are often tailored to the hardware or operating system of the target, so reconnaissance is often the first
step. The IP addresses of the hosts, the open ports, and the operating systems the hosts are running is
invaluable information to an attacker. Probing your network can be as simple as an attacker performing an
address sweep or port scan to a more involved operation like sending TCP packets with invalid combinations of
flags to see how your firewall reacts.
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Address sweeps

An address sweep is a basic network scanning technique to determine which addresses in an address range have
active hosts. A typical address sweep involves sending an ICMPECHO request (a ping) to each address in an
address range to attempt to get a response. A response signifies that there is a host at this address that
responded to the ping. It then becomes a target for more detailed and potentially invasive attacks.

Address sweeps do not always reveal all the hosts in an address range because some systemsmay be configured
to ignore ECHO requests and not respond, and some firewalls and gateways may be configured to prevent ECHO
requests from being transmitted to the destination network. Despite this shortcoming, Address sweeps are still
used because they are simple to perform with software tools that automate the process.

Use the icmp_sweep anomaly in a DoS policy to protect against address sweeps.

There are a number of IPS signatures to detect the use of ICMP probes that can gather information about your
network. These signatures include AddressMask, Traceroute, ICMP.Invalid.Packet.Size, and
ICMP.Oversized.Packet. Include ICMP protocol signatures in your IPS sensors to protect against these
probes/attacks.

Port scans

Potential attackers may run a port scan on one or more of your hosts. This involves trying to establish a
communication session to each port on a host. If the connection is successful, a service may be available that the
attacker can exploit.

Use the DoS anomaly check for tcp_port_scan to limit the number of sessions (complete and incomplete)
from a single source IP address to the configured threshold. If the number of sessions exceed the threshold, the
configured action is taken.

Use the DoS anomaly check for udp_scan to limit UDP sessions in the same way.

Probes using IP traffic options

Every TCP packet has space reserved for eight flags or control bits. They are used for communicating various
control messages. Although space in the packet is reserved for all eight, there are various combinations of flags
that should never happen in normal network operation. For example, the SYN flag, used to initiate a session, and
the FIN flag, used to end a session, should never be set in the same packet.

Attackers may create packets with these invalid combinations to test how a host will react. Various operating
systems and hardware react in different ways, giving a potential attackers clues about the components of your
network.

The IPS signature TCP.Bad.Flags detects these invalid combinations. The default action is pass though you
can override the default and set it to Block in your IPS sensor.

Configure packet replay and TCP sequence checking

The anti-replay CLI command allows you to set the level of checking for packet replay and TCP sequence
checking (or TCP Sequence (SEQ) number checking). All TCP packets contain a Sequence Number (SEQ) and an
Acknowledgement Number (ACK). The TCP protocol uses these numbers for error free end-to-end
communications. TCP sequence checking can also be used to validate individual packets.

FortiGate units use TCP sequence checking to make sure that a packet is part of a TCP session. By default, if a
packet is received with sequence numbers that fall out of the expected range, the FortiGate unit drops the
packet. This is normally a desired behavior, since it means that the packet is invalid. But in some cases you may
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want to configure different levels of anti-replay checking if some of your network equipment uses non-RFC
methods when sending packets.

Configure the anti-replay CLI command:

config system global
set anti-replay {disable | loose | strict}

end

You can set anti-replay protection to the following settings:

l disable— No anti-replay protection.
l loose— Perform packet sequence checking and ICMP anti-replay checking with the following criteria:
l The SYN, FIN, and RST bit can not appear in the same packet.
l The FortiGate unit does not allow more than one ICMP error packet through before it receives a normal TCP or

UDP packet.
l If the FortiGate unit receives an RST packet, and check-reset-range is set to strict, the FortiGate unit checks to

determine if its sequence number in the RST is within the un-ACKed data and drops the packet if the sequence
number is incorrect.

l strict— Performs all of the loose checking but for each new session also checks to determine of the TCP
sequence number in a SYN packet has been calculated correctly and started from the correct value for each new
session. Strict anti-replay checking can also help prevent SYN flooding.

If any packet fails a check it is dropped.

Configure ICMP error message verification

Enable ICMP error message verification to ensure an attacker can not send an invalid ICMP error message.

config system global
check-reset-range {disable | strict}

end

l disable— the FortiGate unit does not validate ICMP error messages.
l strict— enable ICMP error message checking.

If the FortiGate unit receives an ICMP error packet that contains an embedded IP(A,B) | TCP(C,D) header, then if
FortiOS can locate the A:C->B:D session it checks to make sure that the sequence number in the TCP header is
within the range recorded in the session. If the sequence number is not in range then the ICMP packet is
dropped. Strict checking also affects how the anti-replay option checks packets.

Protocol header checking

Select the level of checking performed on protocol headers.

config system global
check-protocol-header {loose | strict}

end

l loose— the FortiGate unit performs basic header checking to verify that a packet is part of a session and should
be processed. Basic header checking includes verifying that the layer-4 protocol header length, the IP header
length, the IP version, the IP checksum, IP options are correct, etc.

l strict— the FortiGate unit does the same checking as above plus it verifies that ESP packets have the correct
sequence number, SPI, and data length.

If the packet fails header checking it is dropped by the FortiGate unit.
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Evasion techniques

Attackers employ a wide range of tactics to try to disguise their techniques. If an attacker disguises a known
attack in such a way that it is not recognized, the attack will evade your security and possibly succeed. FortiGate
security recognizes a wide variety of evasion techniques and normalizes data traffic before inspecting it.

Packet fragmentation

Information sent across local networks and the Internet is encapsulated in packets. There is a maximum
allowable size for packets and this maximum size varies depending on network configuration and equipment
limitations. If a packet arrives at a switch or gateway and it is too large, the data it carries is divided among two or
more smaller packets before being forwarded. This is called fragmentation.

When fragmented packets arrive at their destination, they are reassembled and read. If the fragments do not
arrive together, they must be held until all of the fragments arrive. Reassembly of a packet requires all of the
fragments.

The FortiGate unit automatically reassembles fragmented packets before processing them because fragmented
packets can evade security measures. This reassembly of packets affects TCP, UDP and IP packets. There can
be some variation though in what process does the reassembling. The IPS engine, nTurbo and the kernel all can
do defragmentation.

For example, you have configured the FortiGate unit to block access to the example.org web site. Any checks for
example.com will fail if a fragmented packet arrives and one fragment contains http://www.exa while the
other contains mple.com/. Viruses and malware can be fragmented and avoid detection in the same way. The
FortiGate unit will reassemble fragmented packets before examining network data to ensure that inadvertent or
deliberate packet fragmentation does not hide threats in network traffic.

Non-standard ports

Most traffic is sent on a standard port based on the traffic type. The FortiGate unit recognizes most traffic by
packet content rather than the TCP/UDP port and uses the proper IPS signatures to examine it. Protocols
recognized regardless of port include DHCP, DNP3, FTP, HTTP, IMAP, MSRPC, NNTP, POP3, RSTP, SIP,
SMTP, and SSL, as well as the supported IM/P2P application protocols.

In this way, the FortiGate unit will recognize HTTP traffic being sent on port 25 as HTTP rather than SMTP, for
example. Because the protocol is correctly identified, the FortiGate unit will examine the traffic for any enabled
HTTP signatures.

Negotiation codes

Telnet and FTP servers and clients support the use of negotiation information to allow the server to report what
features it supports. This information has been used to exploit vulnerable servers. To avoid this problem, the
FortiGate unit removes negotiation codes before IPS inspection.

HTTP URL obfuscation

Attackers encode HTML links using various formats to evade detection and bypass security measures. For
example, the URL www.example.com/cgi.bin could be encoded in a number of ways to avoid detection but still
work properly, and be interpreted the same, in a web browser.

The FortiGate prevents the obfuscation by converting the URL to ASCII before inspection.
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HTTP URL obfuscation types

Encoding type Example

No encoding http://www.example.com/cgi.bin/

Decimal
encoding

http://www.example.com/&#99;&#103;&
#105;&#46;&#98;&#105;&#110;&#47;

URL encoding http://www.example.com/%43%47%49
%2E%42%49%4E%2F

ANSI encoding http://www.example.com/%u0063%u0067%
u0069%u002E%u0062%u0069%u006E/

Directory
traversal

http://www.example.com/cgi.bin/test/../

HTTP header obfuscation

The headers of HTTP requests or responses can be modified to make the discovery of patterns and attacks more
difficult. To prevent this, the FortiGate unit will:

l remove junk header lines
l reassemble an HTTP header that’s been folded onto multiple lines
l move request parameters to HTTP POST body from the URL

The message is scanned for any enabled HTTP IPS signatures once these problems are corrected.

HTTP body obfuscation

The body content of HTTP traffic can be hidden in an attempt to circumvent security scanning. HTTP content can
be GZipped or deflated to prevent security inspection. The FortiGate unit will uncompress the traffic before
inspecting it.

Another way to hide the contents of HTTP traffic is to send the HTTP body in small pieces, splitting signature
matches across two separate pieces of the HTTP body. The FortiGate unit reassembles these ‘chunked bodies’
before inspection.

Microsoft RPC evasion

Because of its complexity, the Microsoft Remote Procedure Call protocol suite is subject to a number of known
evasion techniques, including:

l SMB-level fragmentation
l DCERPC-level fragmentation
l DCERPCmulti-part fragmentation
l DCERPC UDP fragmentation
l Multiple DCERPC fragments in one packet

The FortiGate unit reassembles the fragments into their original form before inspection.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1029



Network defense Chapter 9 - Firewall

Defending against DoS attacks
A denial of service is the result of an attacker sending an abnormally large amount of network traffic to a target
system. Having to deal with the traffic flood slows down or disables the target system so that legitimate users can
not use it for the duration of the attack.

Any network traffic the target system receives has to be examined, and then accepted or rejected. TCP, UDP,
and ICMP traffic is most commonly used, but a particular type of TCP traffic is the most effective. TCP packets
with the SYN flag are the most efficient DoS attack tool because of how communication sessions are started
between systems.

The “three-way handshake”

Communication sessions between systems start with establishing a TCP/IP connection. This is a simple three
step process, sometimes called a “three-way handshake,” initiated by the client attempting to open the
connection.

1. The client sends a TCP packet with the SYN flag set. With the SYN packet, the client informs the server of its
intention to establish a connection.

2. If the server is able to accept the connection to the client, it sends a packet with the SYN and the ACK flags set.
This simultaneously acknowledges the SYN packet the server has received, and informs the client that the server
intends to establish a connection.

3. To acknowledge receipt of the packet and establish the connection, the client sends an ACK packet.

Establishing a TCP/IP connection

The three-way handshake is a simple way for the server and client to each agree to establish a connection and
acknowledge the other party expressing its intent. Unfortunately, the three-way handshake can be used to
interfere with communication rather than facilitate it.

SYN flood

When a client sends a SYN packet to a server, the server creates an entry in its session table to keep track of the
connection. The server then sends a SYN+ACK packet expecting an ACK reply and the establishment of a
connection.

An attacker intending to disrupt a server with a denial of service (DoS) attack can send a flood of SYN packets and
not respond to the SYN+ACK packets the server sends in response. Networks can be slow and packets can get
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lost so the server will continue to send SYN+ACK packets until it gives up, and removes the failed session from
the session table. If an attacker sends enough SYN packets to the server, the session table will fill completely,
and further connection attempts will be denied until the incomplete sessions time out. Until this happens, the
server is unavailable to service legitimate connection requests.

A single client launches a SYN flood attack

SYN floods are seldom launched from a single address so limiting the number of connection attempts from a
single IP address is not usually effective.

SYN spoofing

With a flood of SYN packets coming from a single attacker, you can limit the number of connection attempts from
the source IP address or block the attacker entirely. To prevent this simple defense from working, or to disguise
the source of the attack, the attacker may spoof the source address and use a number of IP addresses to give the
appearance of a distributed denial of service (DDoS) attack. When the server receives the spoofed SYN packets,
the SYN+ACK replies will go to the spoofed source IP addresses which will either be invalid, or the system
receiving the reply will not know what to do with it.
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A client launches a SYN spoof attack

DDoS SYN flood

The most severe form of SYN attack is the distributed SYN flood, one variety of distributed denial of service
attack (DDoS). Like the SYN flood, the target receives a flood of SYN packets and the ACK+SYN replies are never
answered. The attack is distributed across multiple sources sending SYN packets in a coordinated attack.

Multiple attackers launch a distributed SYN flood

The distributed SYN flood is more difficult to defend against because multiple clients are capable of creating a
larger volume of SYN packets than a single client. Even if the server can cope, the volume of traffic may
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overwhelm a point in the network upstream of the targeted server. The only defense against this is more
bandwidth to prevent any choke-points.

Configuring the SYN threshold to prevent SYN floods

The preferred primary defense against any type of SYN flood is the DoS anomaly check for tcp_syn_flood
threshold. The threshold value sets an upper limit on the number of new incomplete TCP connections allowed per
second. If the number of incomplete connections exceeds the threshold value, and the action is set to Pass, the
FortiGate unit will allow the SYN packets that exceed the threshold. If the action is set to Block, the FortiGate
unit will block the SYN packets that exceed the threshold, but it will allow SYN packets from clients that send
another SYN packet.

The tools attackers use to generate network traffic will not send a second SYN packet when a SYN+ACK response
is not received from the server. These tools will not “retry.” Legitimate clients will retry when no response is
received, and these retries are allowed even if they exceed the threshold with the action set to Block.

SYN proxy

FortiGate units with network acceleration hardware, whether built-in or installed in the form of an add-on module,
offer a third action for the tcp_syn_flood threshold. Instead of Block and Pass, you can choose to Proxy the
incomplete connections that exceed the threshold value.

When the tcp_syn_flood threshold action is set to f, incomplete TCP connections are allowed as normal as
long as the configured threshold is not exceeded. If the threshold is exceeded, the FortiGate unit will intercept
incoming SYN packets from clients and respond with a SYN+ACK packet. If the FortiGate unit receives an ACK
response as expected, it will “replay” this exchange to the server to establish a communication session between
the client and the server, and allow the communication to proceed.

Other flood types

UDP and ICMP packets can also be used for DoS attacks, though they are less common. TCP SYN packets are
so effective because the target receives them and maintains a session table entry for each until they time out.
Attacks using UDP or ICMP packets do not require the same level of attention from a target, rendering them less
effective. The target will usually drop the offending packets immediately, closing the session.

Use the udp_flood and icmp_flood thresholds to defend against these DoS attacks.

DoS policies

DDoS attacks vary in nature and intensity. Attacks aimed at saturating the available bandwidth upstream of your
service can only be countered by adding more bandwidth. DoS policies can help protect against DDoS attacks
that aim to overwhelm your server resources.

DoS policy recommendations

l Use and configure DoS policies to appropriate levels based on your network traffic and topology. This will help drop
traffic if an abnormal amount is received.

l It is important to set a good threshold. The threshold defines the maximum number of sessions/packets per second
of normal traffic. If the threshold is exceeded, the action is triggered. Threshold defaults are general
recommendations, although your network may require very different values.

l One way to find the correct values for your environment is to set the action to Pass and enable logging. Observe
the logs and adjust the threshold values until you can determine the value at which normal traffic begins to generate
attack reports. Set the threshold above this value with the margin you want. Note that the smaller the margin, the
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more protected your system will be from DoS attacks, but your system will also be more likely to generate false
alarms.

Inside FortiOS: Denial of Service (DoS) Protection

FortiOS DoS protection maintains network integrity and performance by identifying and blocking harmful IPv4
and IPv6-based denial of service (DoS) attacks.

About DoS and DDoS attacks
A denial of service (DoS) occurs when an attacker overwhelms server resources by flooding a target system with
anomalous data packets, rendering it unable to service genuine users. A distributed denial of service (DDoS)
occurs when an attacker uses a master computer to control a network of compromised systems, otherwise known
as a ‘botnet’, which collectively inundates the target system with excessive anomalous data packets.

FortiOS DoS and DDoS protection
FortiOS DoS protection identifies potentially harmful traffic that could be part of a DoS or a DDoS attack by
looking for specific traffic anomalies. Traffic anomalies that become DoS attacks include: TCP SYN floods, UDP
floods, ICMP floods, TCP port scans, TCP session attacks, UDP session attacks, ICMP session attacks, and
ICMP sweep attacks. Only traffic identified as part of a DoS attack is blocked; connections from legitimate users
are processed normally.

FortiOS applies DoS protection very early in its traffic processing sequence to minimize the effect of a DoS attack
on FortiOS system performance. DoS protection is the first step for packets after they are received by a FortiGate
interface. Potential DoS attacks are detected and blocked before the packets are sent to other FortiOS systems.

FortiOS also includes an access control list feature that is implemented next. This accelerated ACL technology
uses NP6 processors to block traffic (including DoS attacks) by source and destination address and service again
before the packets are sent to the FortiGate CPU.
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FortiOS DoS protection can operate in a standard configuration or operate out of band in sniffer mode, also
known as one-arm mode, similar to intrusion detection systems. When operating in sniffer mode the FortiGate
unit detects attacks and logs them without blocking them.

FortiOS DoS policies determine the course of action to take when anomalous traffic reaches a configured packet
rate threshold. You can block an attacker, block an interface, block an attacker and interface, or allow traffic to
pass through for monitoring purposes. This allows you to maintain network security by gathering information
about attacks, monitor potentially offending traffic, or block offenders for the most protection.

FortiGates with NP6 processors also support synproxy DoS protection. An NP6-accelerated TCP SYN proxy
offloads the three-way TCP handshake TCP SYN anomaly checking DoS protection to NP6 processors.

FortiOS DDoS Prevention
In addition to using DoS protection for protection against DoS attacks, FortiOS includes a number of features that
prevent the spread of Botnet and C&C activity. Mobile Malware or Botnet and C&C protection keeps Botnet and
C&C code from entering a protected network and compromising protected systems. As a result, systems on the
protected network cannot become Botnet clients.

In addition, FortiOS can monitor and block outgoing Botnet connection attempts. Monitoring allows you to find
and remove Botnet clients from your network and blocking prevents infected systems from communicating with
Botnet sites.
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Configuration options
Choose the standard configuration for maximum protection or configure sniffer mode to gather information.

Standard configuration

DoS protection is commonly configured on a FortiGate unit that connects a private or DMZ network to the
Internet or on a FortiWiFi unit that connects a wireless LAN to an internal network and to the Internet. All Internet
traffic or wireless LAN traffic passes through DoS protection in the FortiGate unit or the FortiWiFi unit.

Out of band configuration (sniffer mode)

A FortiGate unit in sniffer mode operates out of band as a one-armed Intrusion Detection System by detecting
and reporting attacks. It does not process network traffic nor does it take action against threats. The FortiGate
interface operating in sniffer mode is connected to a Test Access Point (TAP) or a Switch Port Analyzer (SPAN)
port that processes all of the traffic to be analyzed. The TAP or SPAN sends a copy of the switch traffic to the out
of band FortiGate for analysis.

FortiOS records log messages and sends alerts to system administrators when a DoS attack is detected. IDS
scanning does not affect network performance or network traffic if the IDS fails or goes offline.
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DoS policies
DoS policies provide effective and early DoS detection while remaining light on system resources. They are
configured to monitor and to stop traffic with abnormal patterns or attributes. The DoS policy recognizes traffic as
a threat when the traffic reaches a user-configured packet rate threshold. The policy then determines the
appropriate action. In addition to choosing whether or not to log each type of anomaly, you can choose to pass or
block threats.

DoS policy anomaly protection is applied to all incoming traffic to a single FortiGate interface, but you can narrow
policies by specifying service, source address, and destination address. The FortiGate unit processes DoS
policies in their own respective order first, followed by all other firewall policies.

Hardware acceleration
Hardware acceleration enhances protection and increases the efficiency of your network. FortiOS integrated
Content Processors (CPs), Network Processors (NPs), and Security Processors (SPs) accelerate specialized
security processing. DoS SYN proxy protection is built in to NP6 processors and many Fortinet Security
Processors, like the CE4, XE2, and FE8, to guard against TCP SYN floods. TCP packets with the SYN flag are the
most efficient DoS attack tool because of how communication sessions are initiated between systems. NP6 and
SP processors can offload TCP SYN flood attack detection and blocking. The SPmodule increases a FortiGate
unit’s capacity to protect against TCP SYN flood attacks while minimizing the effect of attacks on the FortiGate
unit’s overall performance and the network performance. The result is improved capacity and overall system
performance.

The FortiGuard Center
The FortiGuard Center shows information on all the most recent FortiGuard news, including information
concerning zero-day research and hot intrusion detections. Research papers are also available that concern a
variety of current security issues.

To view recent developments, go to http://www.fortiguard.com/static/intrusionprevention.html.
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Firewall Policies

The firewall policies of the FortiGate are one of the most important aspects of the appliance. There are a lot of
building blocks and configurations involved in setting up a firewall and it within the policies that a lot of these
components come together to form a cohesive unit to perform the firewall's main function, analyzing network
traffic and responding appropriately to the results of that analysis.

There are a few different kinds of policies and in most cases these are further divided into IPv4 and IPv6 versions:

l IPv4 Policy - used for managing traffic going through the appliance using IPv4 protocols
l IPv6 Policy - used for managing traffic going through the appliance using IPv6 protocols
l NAT64 Policy - used for managing traffic going through the appliance that converts from IPv6 on the incoming

interface to IPv4 on the outgoing interface
l NAT46 Policy - used for managing traffic going through the appliance that converts from IPv4 on the incoming

interface to IPv6 on the outgoing interface
l Multicast Policy - used to manage traffic sent to multiple destinations
l IPv4 Access Control List - used to filter out packets based on specific IPV4 parameters.
l IPv6 Access Control List - used to filter out packets based on specific IPV6 parameters.
l IPv4 DoS Policy - used to prevent malicious or flawed packets on an IPv4 interface from denying access to users.
l IPv6 DoS Policy - used to prevent malicious or flawed packets on an IPv6 interface from denying access to users.

Because the policy determines whether or not NAT will be used, it is also import to look at how to configure:

l Central SNAT - used for granular controlling when NATing is in use.

Viewing Firewall Policies
To find a Policy window, follow one of these path in the GUI:

l Policy & Objects> IPv4 Policy
l Policy & Objects> IPv6 Policy
l Policy & Objects> NAT64 Policy
l Policy & Objects> NAT46 Policy
l Policy & Objects> Proxy Policy
l Policy & Objects> Multicast Policy

You may notice other policy options on the left window pane such as:

l Policy & Objects> IPv4 DoS Policy
l Policy & Objects> IPv6 DoS Policy
l Policy & Objects> Local InPolicy

These are different enough that they have their own descriptions in the sections that relate to them.

Menu Items

There are some variations, but there are some common elements share by all of them. There is a menu bar
across the top. The menu bar will have the following items going from left to right:
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l Create New button
l Edit button
l Delete button
l Search field
l Interface Pair View- Displays the policies in the order that they are checked for matching traffic, grouped by the

pairs of Incoming and Outgoing interfaces. For instance, all of the policies referencing traffic from WAN1 to DMZ
will be in one section. The policies referencing traffic from DMZ to WAN1 will be in another section. The sections
are collapsible so that you only need to look at the sections with policies you are interested in.

l By Sequence- Displays the policies in the order that they are checked for matching traffic without any grouping.

Menu items not shared by all policies

l Policy Lookup - (IPv4, IPv6 )
l NAT64 Forwarding - (NAT64)

The Table of Policies

Columns

The tables that make up the Policy window are based on rows which represent individual policies and the columns
that represent the various parameters or status within the policy. The columns are customizable by which
columns are included and what order they are in.

The table can be laid out a number ways to suit the viewer. There is a column for most of the important pieces of
information that you might be interested in seeing, but a lot of them are hidden by default. If you had a large
enough screen, you might be able to show all of the columns, but even then it might look a bit busy and crammed
together. Figure out which pieces of information are most important to you and hide the rest.

To configure which columns are visible and which are hidden, right click on the header row of the table. This will
present a drop down menu. The drop down will be divided into sections. At the top will be the Selected
Columnswhich are currently visible, and the next section will be Available Columnswhich show which
columns are available to add to the table.

To move a column from the Available list to the Selected list just click on it. To move a column from the
Selected list to the Available list, it also just takes a click of the mouse. To make the changes show up on the
table, go to the bottom of the drop down menu and select Apply. Any additions to the table will show up on the
right side.

One of the more useful ones that can be added is the ID column. The reason for adding this one is that within the
configuration file and CLI, the policies are referenced by their ID number. Some policy settings are only available
for configuration in the CLI. If you are looking in the CLI you will see that the only designation for a policy is its
number and if you wish to edit the policy or change its order in the sequence you will be asked to move it before or
after another policy by referencing its number.

How “Any” policy can remove the Interface Pair View

The FortiGate unit will automatically change the view on the policy list page to By Sequencewhenever there is a
policy containing “any” as the Source or Destination interface. If the Interface Pair View is grayed out it is likely
that one or more of the policies has used the “any” interface.

By using the “any” interface, the policy should go into multiple sections because it could effectively be any of a
number of interface pairings. As mentioned, policies are sectioned by using the interface pairings (for example,
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port1 -> port2) and each section has its own specific policy order. The order in which a policy is checked for
matching criteria to a packet’s information is based solely on the position of the policy within its section or within
the entire list of policies as a whole but if the policy is in multiple sections at the same time there is no mechanism
for placing the policy in a proper order within all of those sections at the same time because it is a manual process
and there is no parameter to compare the precedence of one section or policy over the other. Thus a conflict is
created. In order to resolve the conflict the FortiGate firewall removes that aspect of the sections so that there is
no need to compare and find precedence between the sections and it therefore has only the Global View to work
with.

Policy Names
Each policy has a name field. Every policy name must be unique for the current VDOM regardless of policy type.
Previous to FortiOS 5.4, this field was optional.

On upgrading from an earlier version of FortiOS to 5.4, policy names are not assigned
to old policies, but when configuring new policies, a unique name must be assigned to
the policy.

Configuring the Name field

GUI

In the GUI, the field for the policy name is the first field on the editing page.

CLI

In the CLI, the syntax for assigning the policy name is:

config firewall [policy|policy6]
edit 0

set name <policy name>
end

Disabling Policy name requirement

While by default the requirement of having a unique name for each policy is the default, it can be enabled or
disabled. Oddly enough, if disabling the requirement is a one time thing, doing it in the CLI is more
straightforward.

This setting is VDOM based so if you are running multiple VDOMs, you will
have to enter the correct VDOM before entering the CLI commands or
turning the feature on or off in the GUI.

GUI

To edit the requirement in the GUI, the ability to do so must be enabled in the CLI. The syntax is:

config system settings
set gui-allow-unnamed-policy [enable|disable]
end

1040 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 9 - Firewall Firewall Policies

Once it has been enabled, the requirement for named policies can be relaxed by going to System > Feature
Visibility. AllowUnnamed Policies can be found underAdditional Features. Here you can toggle the
requirement on and off.

CLI

To change the requirement in the CLI, use the following syntax:

config system settings
set gui-advance policy [enable|disable]
end

IPv4 Policy

To configure a IPv4 policy in the GUI

1. Go to Policy & Objects > IPv4 Policy
The right side window will display a table of the existing IPv4 Policies.

l To edit an existing policy, double click on the policy you wish to edit
l To create a new policy, select the Create New icon in the top left side of the right window.

2. Make sure the policy has a name in the Name field

By default, a policy is required to have a name, but it is possible to toggle this
requirement on or off in the CLI, or in the GUI if you have first enabled the GUI option
in the CLI.

3. Set the Incoming Interface parameter by selecting the field with the "+" next to the field label. Selecting the field
will slide out a window from the right where you can select from the available interfaces. You can select one or
more specific interfaces or you can select the any option. Choosing the any option will remove any other
interfaces. For more information on interfaces, check the Concepts section called Interfaces and Zones.

4. Set theOutgoing Interface parameter by selecting the field with the "+" next to the field label. (Same rules apply
as with the above step.)

Alias names for interfaces, if used, appear in the headings for the Interface Pair View
or what used to be called the Section View.
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Multiple interfaces or ANY interface can be added to a firewall policy. This
feature can be enabled or disabled in the GUI by going to the System >
Feature Select page and togglingMultiple Interface Policies.

When selecting the Incoming or Outgoing interface of a policy, there are a
few choices:

l The ANY interface (choosing this will remove all other interfaces)
l l A single specific interface
l l multiple specific interfaces (can be added at the same time or one at a time)

The GUI is intuitive and straightforward on how to do this. Click on the "+"
symbol in the interface field and then select the desired interfaces from the
side menu. There are a couple of ways to do it in the CLI:

1. Set the interfaces all at once:

config firewall policy
edit 0

set srcintf wan1 wan2
end

2. Set the first interface and append additional ones:

config firewall policy
edit 0

set srcintf wan1
append srcintf wan2
end

5. Set the Source parameter by selecting the field with the "+" next to the field label. The source in this case is either
the source address, source user or source device of the initiating traffic. When the field is selected a window will
slide out from the right. Tabs indcating Address, User or Device options are there to help categorize the options
along with the option to search. In order to be able to select one of these options it needs to be configured as a
firewall object before hand. The "+" icon next to the Search field is a shortcut for creating a new firewall object
based on the tab that is currently selected. For the Address and Device tabs, single or multiple options can be
selected unless the all option is chosen in which case, it will be the only option.

6. Set the Destination Address parameter by selecting the field with the "+" next to the field label. This field is
similar to the Source field but address objects are the only available options to select. Single or multiple options
can be selected unless the all option is chosen in which case, it will be the only option. For more information on
addresses, check the Firewall Objects section called Addresses.

7. Set the Schedule parameter by using the drop down menu to select a preconfigured schedule. The "+" icon next
to the Search field is a shortcut for creating a new schedule object. For more information on addresses, check the
Firewall Objects section called Firewall schedules

8. Set the Service parameter by selecting the field with the "+" next to the field label. (Same mechanics for selection
apply as with the other similar fields in this window.) Single or multiple options can be selected unless the ALL
option is chosen in which case, it will be the only option. For more information on services, check the Firewall
Objects section called Services and TCP ports.

9. Set the Action parameter. Select one of the following options for the action:
l ACCEPT - lets the traffic through to the next phase of analysis
l DENY - drops the session
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l LEARN - collects information about the traffic for future analysis
l IPsec - for using with IPsec tunnels

Because the choice of Action determines the settings and options below this parameter in the window the rest
of the step are associated with a specificAction.

Settings if the ACCEPT action is selected.

Firewall / Network Options

10. Set the NAT parameter by toggling the slider button.(gray means it is disabled)
The NAT setting section is affected by whether or not Central NAT is enabled.

If Central NAT is enabled, the only option in Firewall / Network options will be whether to enable or disable
NAT. The rest of the NAT parameters will be set in the Central SNAT page.

If Central NAT is disabled, there are two additional settings in the Policy configuration page.

11. Set the Fixed Port parameter by toggling the slider button.(gray means it is disabled)
12. Set the IP Pool Configuration by selection one of the options of:

l Use Outgoing Interface Address
l Use Dynamic IP Pool

If the Use Dynamic IP Pool option is selected, an additional field will appear with the + icon. Selecting this
field will slide out a window from the right where a preexisting IP Pool can be chosen. One or more IP Pools
can be chosen and the "+" icon next to the Search field is a shortcut for creating a new IP Pool.

Security Profiles

13. Enabling the Use Security Profile Group option will allow the selection of a profile group instead of selecting
the individual profiles for the policy.

14. Disable or enable the variousSecurity Profiles. Once a Profile has been toggled into the enabled mode a drop
down menu will appear for the purpose of choosing a specific profile. Only one profile can be chosen for each
profile type. The "+" icon next to the Search field in the drop down menu is a shortcut for creating a new profile.

The list of Security Profiles available to set includes:

l AntiVirus
l Web Filter
l DNS Filter
l Application Control
l CASI
l IPS
l Anti-Spam
l DLP Sensor
l VoIP
l ICAP
l Web Application Firewall
l Proxy Options
l SSL/SSH Inspection

Logging Options

15. Set the Log Allowed Traffic parameter by toggling the slider button (gray means it is disabled).
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If the Log Allowed Traffic setting is enabled, choose whether to log just Security Events orAll Sessions
and determine whether or not to keep a record of the packets by toggling the Capture Packets setting on or
off.

16. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
17. Toggle whether or not to Enable this policy.The default is enabled.
18. Select theOK button to save the policy.

Settings if the DENY action is selected

Enable the Log Violation Traffic setting by toggling the slider button.

10. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
11. Toggle whether or not to Enable this policy.The default is enabled.
12. Select theOK button to save the policy.

Settings if the LEARN action is selected

To get more information on the LEARN option, read the Learning mode for Firewall policies topic in What's new
for Firewall in 5.6

Firewall / Network Options

10. Set the NAT parameter by toggling the slider button.(gray means it is disabled). Unlike the ACCEPT option,
whether or not Central NAT is enabled or disabled does not affect this settings options.

11. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
12. Toggle whether or not to Enable this policy.The default is enabled.
13. Select theOK button to save the policy.

Settings if the IPsec action is selected

VPN Tunnel

10. For the VPN Tunnel field, use the drop down menu to select the VPN tunnel that you want the policy associated
with.

11. Toggle the sliding button to enable or disable the option to Allow traffic to be initiated from the remote site
Security Profiles

12. Disable or enable the variousSecurity Profiles. Once a Profile has been toggled into the enabled mode a drop
down menu will appear for the purpose of choosing a specific profile. Only one profile can be chosen for each
profile type. The "+" icon next to the Search field in the drop down menu is a shortcut for creating a new profile.

The list of Security Profiles available to set includes:

l AntiVirus
l Web Filter
l DNS Filter
l Application Control
l CASI
l IPS
l Anti-Spam
l DLP Sensor
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l VoIP
l ICAP
l Web Application Firewall
l Proxy Options
l SSL/SSH Inspection

Logging Options

13. Set the Log Allowed Traffic parameter by toggling the slider button (gray means it is disabled).
If the Log Allowed Traffic setting is enabled, choose whether to log just Security Events orAll Sessions
and determine whether or not to keep a record of the packets by toggling the Capture Packets setting on or
off.

14. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
15. Toggle whether or not to Enable this policy.The default is enabled.
16. Select theOK button to save the policy.

IPv6 Policy

To configure a IPv6 policy in the GUI

1. Go to Policy & Objects > IPv6 Policy
The right side window will display a table of the existing IPv6 Policies.

l To edit an existing policy, double click on the policy you wish to edit
l To create a new policy, select the Create New icon in the top left side of the right window.

2. Make sure the policy has a name in the Name field

By default, a policy is required to have a name, but it is possible to toggle this
requirement on or off in the CLI, or in the GUI if you have first enabled the GUI option
in the CLI.

3. Set the Incoming Interface parameter by selecting the field with the "+" next to the field label. Selecting the field
will slide out a window from the right where you can select from the available interfaces. You can select one or
more specific interfaces or you can select the any option. Choosing the any option will remove any other
interfaces. For more information on interfaces, check the Concepts section called Interfaces and Zones.

4. Set theOutgoing Interface parameter by selecting the field with the "+" next to the field label. (Same rules apply
as with the above step.)

5. Set the Source parameter by selecting the field with the "+" next to the field label. The source in this case is either
the source address, source user or source device of the initiating traffic. When the field is selected a window will
slide out from the right. Tabs indicating Address, User or Device options are there to help categorize the options
along with the option to search. In order to be able to select one of these options it needs to be configured as a
firewall object before hand. The "+" icon next to the Search field is a shortcut for creating a new firewall object
based on the tab that is currently selected. For the Address and Device tabs, single or multiple options can be
selected unless the all option is chosen in which case, it will be the only option.
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6. Set the Destination Address parameter by selecting the field with the "+" next to the field label. This field is
similar to the Source field but address objects are the only available options to select. Single or multiple options
can be selected unless the all option is chosen in which case, it will be the only option. For more information on
addresses, check the Firewall Objects section called Addresses.

7. Set the Schedule parameter by using the drop down menu to select a preconfigured schedule. The "+" icon next
to the Search field is a shortcut for creating a new schedule object. For more information on addresses, check the
Firewall Objects section called Firewall schedules

8. Set the Service parameter by selecting the field with the "+" next to the field label. (Same mechanics for selection
apply as with the other similar fields in this window.) Single or multiple options can be selected unless the ALL
option is chosen in which case, it will be the only option. For more information on services, check the Firewall
Objects section called Services and TCP ports.

9. Set the Action parameter. Select one of the following options for the action:
l ACCEPT - lets the traffic through to the next phase of analysis
l DENY - drops the session

While there are not as many Action options as with the IPv4 policy, because the choice of Action determines
the settings and options below this parameter in the window the rest of the step are associated with a specific
Action.

Settings if the ACCEPT action is selected.

Firewall / Network Options

10. Set the NAT parameter by toggling the slider button.(gray means it is disabled)
11. Set the IP Pool Configuration by selection one of the options of:

l Use Outgoing Interface Address
l Use Dynamic IP Pool

If the Use Dynamic IP Pool option is selected:

l An additional field will appear with the + icon. Selecting this field will slide out a window from the right where a
preexisting IP Pool can be chosen. One or more IP Pools can be chosen and the "+" icon next to the Search
field is a shortcut for creating a new IP Pool.

l An additional option to Preserve the Source Portwill appear as a toggle option. If the slider button is grayed
out it is disabled.

Security Profiles

12. Enabling the Use Security Profile Group option will allow the selection of a profile group instead of selecting
the individual profiles for the policy.

13. Disable or enable the variousSecurity Profiles. Once a Profile has been toggled into the enabled mode a drop
down menu will appear for the purpose of choosing a specific profile. Only one profile can be chosen for each
profile type. The "+" icon next to the Search field in the drop down menu is a shortcut for creating a new profile.

The list of Security Profiles available to set includes:

l AntiVirus
l Web Filter
l Application Control
l IPS
l Anti-Spam
l DLP Sensor
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l VoIP
l ICAP

Logging Options

14. Set the Log Allowed Traffic parameter by toggling the slider button (gray means it is disabled).
If the Log Allowed Traffic setting is enabled, choose whether to log just Security Events orAll Sessions
and determine whether or not to keep a record of the packets by toggling the Capture Packets setting on or
off.

15. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
16. Toggle whether or not to Enable this policy.The default is enabled.
17. Select theOK button to save the policy.

Settings if the DENY action is selected

Enable the Log Violation Traffic setting by toggling the slider button.

10. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
11. Toggle whether or not to Enable this policy.The default is enabled.
12. Select theOK button to save the policy.

NAT64 Policy

To configure a NAT64 policy in the GUI

1. Go to Policy & Objects > NAT64 Policy
The right side window will display a table of the existing NAT64 Policies.

l To edit an existing policy, double click on the policy you wish to edit
l To create a new policy, select the Create New icon in the top left side of the right window.

2. Set the Incoming Interface parameter by selecting the field with the "+" next to the field label. Selecting the field
will slide out a window from the right where you can select from the available interfaces. You can select one or
more specific interfaces or you can select the any option. Choosing the any option will remove any other
interfaces. For more information on interfaces, check the Concepts section called Interfaces and Zones.

3. Set theOutgoing Interface parameter by selecting the field with the "+" next to the field label. (Same rules apply
as with the above step.)

4. Set the Source Address parameter by selecting the field with the "+" next to the field label. The source in this
case is an IPv6 Address object of the initiating traffic. When the field is selected a window will slide out from the
right. In order to be able to select one of these options it needs to be configured as a firewall object before hand.
The "+" icon next to the Search field is a shortcut for creating a new firewall object based on the tab that is
currently selected. Single or multiple options can be selected unless the all option is chosen in which case, it will
be the only option.

5. Set the Destination Address parameter by selecting the field with the "+" next to the field label. This field is
similar to the Source Addressfield. Single or multiple options can be selected unless the all option is chosen in
which case, it will be the only option. For more information on addresses, check the Firewall Objects section called
Addresses.

6. Set the Schedule parameter by using the drop down menu to select a preconfigured schedule. The "+" icon next
to the Search field is a shortcut for creating a new schedule object. For more information on addresses, check the
Firewall Objects section called Firewall schedules
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7. Set the Service parameter by selecting the field with the "+" next to the field label. (Same mechanics for selection
apply as with the other similar fields in this window.) Single or multiple options can be selected unless the ALL
option is chosen in which case, it will be the only option. For more information on services, check the Firewall
Objects section called Services and TCP ports.

8. Set the Action parameter. Select one of the following options for the action:
l ACCEPT - lets the traffic through to the next phase of analysis
l DENY - drops the session

While there are not as many Action options as with the IPv4 policy, because the choice of Action determines
the settings and options below this parameter in the window the rest of the step are associated with a specific
Action.

Settings if the ACCEPT action is selected.

Firewall / Network Options

10. Skip the NAT setting. This type of policy is intended only for traffic that is being NATed from IPv6 to IPv4, because
without NATing the traffic couldn't reach its destination, so disabling NAT would be pointless.

11. Set the IP Pool Configuration by selection one of the options of:
l Use Outgoing Interface Address
l Use Dynamic IP Pool

If the Use Dynamic IP Pool option is selected, an additional field will appear with the + icon. Selecting this
field will slide out a window from the right where a preexisting IP Pool can be chosen. One or more IP Pools
can be chosen and the "+" icon next to the Search field is a shortcut for creating a new IP Pool.

12. Set the Log Allowed Traffic parameter by toggling the slider button (gray means it is disabled).
If the Log Allowed Traffic setting is enabled, choose whether to log just Security Events orAll Sessions
and determine whether or not to keep a record of the packets by toggling the Capture Packets setting on or
off.

13. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
14. Toggle whether or not to Enable this policy.The default is enabled.
15. Select theOK button to save the policy.

Settings if the DENY action is selected

Enable the Log Violation Traffic setting by toggling the slider button.

10. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
11. Toggle whether or not to Enable this policy.The default is enabled.
12. Select theOK button to save the policy.

NAT46 Policy

To configure a NAT46 policy in the GUI

1. Go to Policy & Objects > NAT46 Policy
The right side window will display a table of the existing NAT46 Policies.
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l To edit an existing policy, double click on the policy you wish to edit
l To create a new policy, select the Create New icon in the top left side of the right window.

2. Set the Incoming Interface parameter by selecting the field with the "+" next to the field label. Selecting the field
will slide out a window from the right where you can select from the available interfaces. You can select one or
more specific interfaces or you can select the any option. Choosing the any option will remove any other
interfaces. For more information on interfaces, check the Concepts section called Interfaces and Zones.

3. Set theOutgoing Interface parameter by selecting the field with the "+" next to the field label. (Same rules apply
as with the above step.)

4. Set the Source parameter by selecting the field with the "+" next to the field label. The source in this case is either
the source address, source user or source device of the initiating traffic. When the field is selected a window will
slide out from the right. Tabs indicating Address, User or Device options are there to help categorize the options
along with the option to search. In order to be able to select one of these options it needs to be configured as a
firewall object before hand. The "+" icon next to the Search field is a shortcut for creating a new firewall object
based on the tab that is currently selected. For the Address and Device tabs, single or multiple options can be
selected unless the all option is chosen in which case, it will be the only option.

5. Set the Destination Address parameter by selecting the field with the "+" next to the field label. This field is
similar to the Source field but address objects are the only available options to select. Single or multiple options
can be selected unless the all option is chosen in which case, it will be the only option. For more information on
addresses, check the Firewall Objects section called Addresses.

6. Set the Schedule parameter by using the drop down menu to select a preconfigured schedule. The "+" icon next
to the Search field is a shortcut for creating a new schedule object. For more information on addresses, check the
Firewall Objects section called Firewall schedules

7. Set the Service parameter by selecting the field with the "+" next to the field label. (Same mechanics for selection
apply as with the other similar fields in this window.) Single or multiple options can be selected unless the ALL
option is chosen in which case, it will be the only option. For more information on services, check the Firewall
Objects section called Services and TCP ports.

8. Set the Action parameter. Select one of the following options for the action:
l ACCEPT - lets the traffic through to the next phase of analysis
l DENY - drops the session

While there are not as many Action options as with the IPv4 policy, because the choice of Action determines
the settings and options below this parameter in the window the rest of the step are associated with a specific
Action.

Settings if the ACCEPT action is selected.

Firewall / Network Options

10. Skip the NAT setting. This type of policy is intended only for traffic that is being NATed from IPv4 to IPv6, because
without NATing the traffic couldn't reach its destination, so disabling NAT would be pointless.

11. Set the Fixed Port parameter by toggling the slider button.(gray means it is disabled)
12. Set the IP Pool Configuration by selection one of the options of:

l Use Outgoing Interface Address
l Use Dynamic IP Pool

If the Use Dynamic IP Pool option is selected, an additional field will appear with the + icon. Selecting this
field will slide out a window from the right where a preexisting IP Pool can be chosen. One or more IP Pools
can be chosen and the "+" icon next to the Search field is a shortcut for creating a new IP Pool.

14. Set the Log Allowed Traffic parameter by toggling the slider button (gray means it is disabled).
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If the Log Allowed Traffic setting is enabled, choose whether to log just Security Events orAll Sessions
and determine whether or not to keep a record of the packets by toggling the Capture Packets setting on or
off.

15. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
16. Toggle whether or not to Enable this policy.The default is enabled.
17. Select theOK button to save the policy.

Settings if the DENY action is selected

Enable the Log Violation Traffic setting by toggling the slider button.

10. Add a comment to give a detailed description of the policy in the Comments field (up to 1023 characters).
11. Toggle whether or not to Enable this policy.The default is enabled.
12. Select theOK button to save the policy.

Central SNAT
The Central NAT feature in not enabled by default. When central-nat is enabled, nat option under IPv4
policies is skipped and SNAT must be done via central-snat-map.

l Info messages and redirection links have been added to IPv4 policy list and dialog to indicate the above
l If NGFWmode is policy-based, then it is assumed that central-nat (specifically SNAT) is enabled implicitly
l The option to toggle NAT in central-snat-map policies has been added (previously it was only shown in NGFW

policy-based mode).
l In central-snat policy dialog, the port-mapping fields for the original port have been updated to accept ranges.
l Nat will be skipped in firewall policy if per vdom central nat is enabled.
l The Central SNAT window contains a table of all of the Central SNAT policies.

To toggle the feature on or off, use the following commands:

config system settings
set central-nat [enable | disable]
end

When Central NAT is enable the Central SNAT section will appear under the Policy & Objects heading in the
GUI.

To configure a Central SNAT entry in the GUI

1. Goto Policy & Objects > Central SNAT
The right side window will display a table of the existing Central SNAT entries.

l To edit an existing entry, double click on the policy you wish to edit
l To create a new entry, select the Create New icon in the top left side of the right window.

2. Set the Incoming Interface(s) by clicking on the "+" in the field. This will slide out a window from the right. Here,
you can select from the available interfaces. Selecting a listed interface will highlight it in the window and add it to
the field. Clicking on an object in this window while it's highlighted will remove it from the field. Multiple selections
are allowed.

3. Set theOutgoing Interface(s) by clicking on the "+" in the field. This will slide out a window from the right. Here,
you can select from the available interfaces. Selecting a listed interface will highlight it in the window and add it to
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the field. Clicking on an object in this window while it's highlighted will remove it from the field. Multiple selections
are allowed.

4. Set the Source Address by clicking on the "+" in the field. This will slide out a window from the right. Here, you
can select from the available address objects. Selecting a listed object will highlight it in the window and add it to
the field. Clicking on an object in this window while it's highlighted will remove it from the field. Multiple selections
are allowed. For more information on addresses, check the Firewall Objects section called Addresses.

5. Set the Destination Address by clicking on the "+" in the field. This will slide out a window from the right. Here,
you can select from the available address objects. Selecting a listed object will highlight it in the window and add it
to the field. Clicking on an object in this window while it's highlighted will remove it from the field. Multiple
selections are allowed.

Under the NAT Heading

6. Set the IP Pool Configuration parameter by selecting eitherUse Outgoing Interface Address orUse
Dynamic IP Pool.

o If Use Dynamic IP Pool is chosen, a field will appear just beneath the option that is used to select which IP Pool
object will be used.Set the IP Pool by clicking on the "+" in the field. This will slide out a window from the right. Here,
you can select from the available objects.

7. Set the Protocol parameter.
There are 5 options for the Protocol.

l ANY - any protocol traffic
l TCP - TCP traffic only. Protocol number set to 6
l UDP - UDP traffic only . Protocol number set to 17
l SCTP - SCTP traffic only. Protocol number set to 132
l Specify - User can specify the traffic filter protocol by setting the protocol number in the field.

6. If the IP Pool is of the type: Overload, Explicit Port Mapping can be enabled.
To enable or disable, use the check box. Once enabled, the following additional parameters will appear.

l Original Source Port - in the left number field, set the starting number of the source port range.
l Translated Port - in the left number field, set the starting number of the translated port range. If it is a single

port range leave the right number field alone. If the right number field is set to a number higher than the left,
the right number field for the Original Source Port will change to make sure the 2 number ranges have a
matching number of ports.

7. Select theOK button to save the entry.

To configure Central SNAT in the CLI

1. Using the CLI interface of your choice, run the following command to get to the correct context.
config firewall central-snat-map

l To edit an existing entry, run the command show or show full-configuration to get a listing of all of
the entries in the map. Take note of the policy ID for the entry to be edited.

l To create a new entry the next step will use the policy ID 0 which will check for an unused ID number and create
an entry with that number.

2. Edit or create an entry with the correct policy ID
edit <policyID number>

Run the following commands to set the parameters of the entry:

set status [enable|disable]

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1051



Firewall Policies Chapter 9 - Firewall

set orig-addr <valid address object preconfigured on the FortiGate>
set srcintf <name of interface on the FortiGate>
set dst-addr <valid address object preconfigured on the FortiGate>
set dstintf <name of interface on the FortiGate>
set protocol <integer for protocol number>
set orig-port <integer for original port number>
set nat-port <integer for translated port number>

3. Save the entry by running the command end or next.

Example scenarios to showing how CLI treats central-nat

Make nat available regardless of NGFW mode.

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897
set nat enable
end

Hide nat-port if nat-ippool is not set or NAT is disabled.

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897
set nat disable
end

Change orig-port to accept range

config firewall central-snat-map
edit 1

set orig-addr "192-86-1-86"
set srcintf "port23"
set dst-addr "192-96-1-96"
set dstintf "port22"
set nat-ippool "pool1"
set protocol 17
set orig-port 2896-2897 (help text changed to: Original port or port range).
set nat-port 35804-35805
end
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IPv4 Access Control List
The IPv4 Access Control List is a specialized policy for denying IPv4 traffic based on:

l the incoming interface
l the source addresses of the traffic
l the destination addresses of the traffic
l the services or ports the traffic is using

The only action available in this policy isDENY.

This feature is available on FortiGates with NP6 processors and is not supported by FortiGates with NP6lite
processors.

To configure a IPv4 Access Control List entry in the GUI

1. Go to Policy & Objects > IPv4 Access Control List
The right side window will display a table of the existing IPv4 Access Control List entries.

l To edit an existing entry, double click on the policy you wish to edit
l To create a new entry, select the Create New icon in the top left side of the right window.

2. Set the Incoming Interface parameter by using the drop down menu to select a single interface.
3. Set the Source Address parameter by selecting the field with the "+" next to the field label. Single or multiple

options can be selected unless the all option is chosen in which case, it will be the only option. For more
information on addresses, check the Firewall Objects section called Addresses.

4. Set the Destination Address parameter by selecting the field with the "+" next to the field label. Single or
multiple options can be selected unless the all option is chosen in which case, it will be the only option.

5. Set the Services parameter by selecting the field with the "+" next to the field label. Single or multiple options can
be selected unless the ALL option is chosen in which case, it will be the only option. For more information on
services, check the Firewall Objects section called Services and TCP ports.

6. Toggle whether or not to Enable this policy.The default is enabled.
7. Select theOK button to save the policy.

To configure a IPv4 Access Control List entry in the CLI

Use the following syntax:

config firewall acl
edit <acl Policy ID #>

set status enable
set interface <interface>
set srcaddr <address object>
set dstaddr <address object>
set service <service object>
end

end

IPv6 Access Control List
The IPv6 Access Control List is a specialized policy for denying IPv6 traffic based on:
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l the incoming interface
l the source addresses of the traffic
l the destination addresses of the traffic
l the services or ports the traffic is using

The only action available in this policy isDENY.

This feature is available on FortiGates with NP6 processors and is not supported by FortiGates with NP6lite
processors.

To configure a IPv6 Access Control List entry in the GUI

1. Goto Policy & Objects > IPv6 Access Control List
The right side window will display a table of the existing IPv6 Access Control List entries.

l To edit an existing entry, double click on the policy you wish to edit
l To create a new entry, select the Create New icon in the top left side of the right window.

2. Set the Incoming Interface parameter by using the drop down menu to select a single interface.
3. Set the Source IPv6 Address parameter by selecting the field with the "+" next to the field label. Single or

multiple options can be selected unless the all option is chosen in which case, it will be the only option. For more
information on addresses, check the Firewall Objects section called Addresses.

4. Set the Destination IPv6 Address parameter by selecting the field with the "+" next to the field label. Single or
multiple options can be selected unless the all option is chosen in which case, it will be the only option.

5. Set the Services parameter by selecting the field with the "+" next to the field label. Single or multiple options can
be selected unless the ALL option is chosen in which case, it will be the only option. For more information on
services, check the Firewall Objects section called Services and TCP ports.

6. Toggle whether or not to Enable this policy.The default is enabled.
7. Select theOK button to save the policy.

To configure a IPv6 Access Control List entry in the CLI

Use the following syntax:

config firewall acl6
edit <acl Policy ID #>

set status enable
set interface <interface>
set srcaddr <address object>
set dstaddr <address object>
set service <service object>
end

end

IPv4 DoS Policy

To configure a IPv4 DoS Policy in the GUI

1. Goto Policy & Objects > IPv4 DoS Policy
The right side window will display a table of the existing IPv4 DoS Policies.
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l To edit an existing policy, double click on the policy you wish to edit
l To create a new policy, select the Create New icon in the top left side of the right window.

2. Set the Incoming Interface parameter by using the drop down menu to select a single interface.
3. Set the Source Address parameter by selecting the field with the "+" next to the field label. Single or multiple

options can be selected unless the all option is chosen in which case, it will be the only option. For more
information on addresses, check the Firewall Objects section called Addresses.

4. Set the Destination Address parameter by selecting the field with the "+" next to the field label. Single or
multiple options can be selected unless the all option is chosen in which case, it will be the only option.

5. Set the Services parameter by selecting the field with the "+" next to the field label. Single or multiple options can
be selected unless the ALL option is chosen in which case, it will be the only option. For more information on
services, check the Firewall Objects section called Services and TCP ports.

6. Set the parameters for the various traffic anomalies.
All of the anomalies that profiles have been created for are in 2 tables. These tables break up the anomaly
profiles into L3 Anomalies and L4 Anomalies. All of the anomalies have the following parameters that can
be set on a per anomaly or per column basis.

l Status - enable or disable the indicated profile
l Logging - enable or disable logging of the indicated profile being triggered
l Action - whether to Pass or Block traffic when the threshold is reached
l Threshold - the number of anomalous packets detected before triggering the action.

The listing of anomaly profiles includes:

L3 Anomalies

l ip_src_session
l ip_dst_session

L4 Anomalies

l tcp_syn_flood
l tcp_port_scan
l tcp_src_session
l tcp_dst_session
l udp_flood
l udp_scan
l udp_src_session
l udp_dst_session
l icmp_flood
l icmp_sweep
l icmp_src_session
l sctp_flood
l sctp_scan
l sctp_src_session
l sctp_dst_session

7. Toggle whether or not to Enable this policy.The default is enabled.
8. Select theOK button to save the policy.
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Example

The company wishes to protect against Denial of Service attach. They have chosen some where they wish to
block the attacks of the incidence goes above a certain threshold and for some others they are just trying to get a
baseline of activity for those types of attacks so they are letting the traffic pass through without action.

l The interface to the Internet is on WAN1
l There is no requirement to specify which addresses are being protected or protected from.
l The protection is to extend to all services.
l The TCP attacks are to be blocked
l The UDP, ICMP, and IP attacks are to be recorded but not blocked.
l The SCTP attack filters are disabled
l The tcp_syn_flood attach’s threshold is to be changed from the default to 1000

Configuring the DoS Policy in the GUI

1. Go to Policy & Objects > Policy > DoS.
2. Create a new policy
3. Fill out the fields with the following information:

Field Value

Incoming Interface wan1

Source Address all

Destination Addresses all

Service ALL

L3 Anomalies

Name Status Logging Action Threshold

ip_src_session enabled enabled Pass 5000

ip_dst_session enabled enabled Pass 5000

L4 Anomalies

Name Status Logging Action Threshold

tcp_syn_flood enabled enabled Block 1000

tcp_port_scan enabled enabled Block <default value>
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Name Status Logging Action Threshold

tcp_src_session enabled enabled Block <default value>

tcp_dst_session enabled enabled Block <default value>

udp_flood enabled enabled Pass <default value>

udp_scan enabled enabled Pass <default value>

udp_src_session enabled enabled Pass <default value>

udp_dst_session enabled enabled Pass <default value>

icmp_flood enabled enabled Pass <default value>

icmp_sweep enabled enabled Pass <default value>

icmp_src_session enabled enabled Pass <default value>

icmp_dst_session enabled enabled Pass <default value>

sctp_flood not enabled not enabled Pass <default value>

sctp_scan not enabled not enabled Pass <default value>

sctp_src_session not enabled not enabled Pass <default value>

sctp_dst_session not enabled not enabled Pass <default value>

4. Toggle the button next to Enable this policy toON.
5. Select OK.

Configuring the IPv4 DoS Policy in the GUI

Using the CLI of your choice, enter the following commands:

config firewall DoS-policy
edit 0

set status enable
set interface wan1
set srcaddr all
set dstaddr all
set service ALL
config anomaly

edit "tcp_syn_flood"
set status enable
set log disable
set action block
set threshold 1000
next

edit "tcp_port_scan"
set status enable
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set log disable
set action block
set threshold 1000
next

edit "tcp_src_session"
set status enable
set log disable
set action block
set threshold 5000
next

edit "tcp_dst_session"
set status enable
set log disable
set action block
set threshold 5000
next

edit "udp_flood"
set status enable
set log disable
set action pass
set threshold 2000
next

edit "udp_scan"
set status enable
set log disable
set action pass
set quarantine none
set threshold 2000
next

edit "udp_src_session"
set status enable
set log disable
set action pass
set threshold 5000
next

edit "udp_dst_session"
set status enable
set log disable
set action pass
set threshold 5000
next

edit "icmp_flood"
set status enable
set log disable
set action pass
set threshold 250
next

edit "icmp_sweep"
set status enable
set log disable
set action pass
set threshold 100
next

edit "icmp_src_session"
set status enable
set log disable
set action pass
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set threshold 300
next

edit "icmp_dst_session"
set status enable
set log disable
set action pass
set threshold 1000
next

edit "ip_src_session"
set status disable
set log enable
set action pass
set threshold 5000
next

edit "ip_dst_session"
set status disable
set log enable
set action pass
set threshold 5000
next

edit "sctp_flood"
set status disable
set log disable
set action pass
set threshold 2000
next

edit "sctp_scan"
set status disable
set log disable
set action pass
set threshold 1000
next

edit "sctp_src_session"
set status disable
set log disable
set action pass
set threshold 5000
next

edit "sctp_dst_session"
set status disable
set log disable
set action pass
set threshold 5000
next

end
end

end

In this example of the CLI, all of the relevant settings have been left in, but some of
them are default settings and would not have to have been specifically set to work. For
instance, if the action parameter is not set it automatically defaults to pass.
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IPv6 DoS Policy

To configure a IPv6 DoS Policy in the GUI

1. Go to Policy & Objects > IPv6 DoS Policy
The right side window will display a table of the existing IPv6 DoS Policies.

l To edit an existing policy, double click on the policy you wish to edit
l To create a new policy, select the Create New icon in the top left side of the right window.

2. Set the Incoming Interface parameter by using the drop down menu to select a single interface.
3. Set the Source IPv6 Address parameter by selecting the field with the "+" next to the field label. Single or

multiple options can be selected unless the all option is chosen in which case, it will be the only option. For more
information on addresses, check the Firewall Objects section called Addresses.

4. Set the Destination IPv6 Address parameter by selecting the field with the "+" next to the field label. Single or
multiple options can be selected unless the all option is chosen in which case, it will be the only option.

5. Set the Services parameter by selecting the field with the "+" next to the field label. Single or multiple options can
be selected unless the ALL option is chosen in which case, it will be the only option. For more information on
services, check the Firewall Objects section called Services and TCP ports.

6. Set the parameters for the various traffic anomalies.
All of the anomalies that profiles have been created for are in 2 tables. These tables break up the anomaly
profiles into L3 Anomalies and L4 Anomalies. All of the anomalies have the following parameters that can
be set on a per anomaly or per column basis.

l Status - enable or disable the indicated profile
l Logging - enable or disable logging of the indicated profile being triggered
l Action - whether to Pass or Block traffic when the threshold is reached
l Threshold - the number of anomalous packets detected before triggering the action.

The listing of anomaly profiles includes:

L3 Anomalies

l ip_src_session
l ip_dst_session

L4 Anomalies

l tcp_syn_flood
l tcp_port_scan
l tcp_src_session
l tcp_dst_session
l udp_flood
l udp_scan
l udp_src_session
l udp_dst_session
l icmp_flood
l icmp_sweep
l icmp_src_session
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l icmp_dst_session
l sctp_flood
l sctp_scan

7. Toggle whether or not to Enable this policy.The default is enabled.
8. Select theOK button to save the policy.

Configuring the IPv6 DoS Policy in the GUI

The configuring of the IPv6 version of the DoS policy is the same as in the IPv4 version , with the exception of first
command.

Using the CLI of your choice, enter the following commands:

config firewall DoS-policy6

The rest of the settings are the same as in IPv4 Dos Policy.

Multicast Policy
TheMulticast PolicyGUI page has been updated from previous versions of the firmware to the new GUI look
and feel. Some functionality has also been changed.

The DNAT option has been removed from the GUI but is still in the CLI.

To create/edit a multicast policy go to Policy & Objects > Multicast Policy. The Listing window on the right
will have buttons along the top that will enable you to

l Create New
l Edit
l Delete

There is also a Search field that will allow you to search or filter the available policies if you have a lot of them.

To configure a new policy left click on the Create New button. This will reveal the New Policy editing window.

1. Using the drop down menu, fill in the field for Incoming Interface. Only one interface can be chosen.
2. Using the drop down menu, fill in the field forOutgoing Interface. Only one interface can be chosen.
3. Set the Source Address parameter by selecting the field with the "+" next to the field label. When the field is

selected a window will slide out from the right. In order for a multicast address to available for selection, the
address object needs to have been created already. Only useable address options will be available for selection.
This means only mutlticast address objects and the more generic all and none options. The "+" icon next to the
Search field is a shortcut for creating a new firewall object. Single or multiple options can be selected unless the
all option is chosen in which case, it will be the only option.

4. Set the Destination Address parameter by selecting the field with the "+" next to the field label. This field is
similar to the Source field. Single or multiple options can be selected unless the all option is chosen in which
case, it will be the only option.

5. Set the Action parameter. This will be to eitherACCEPT orDENY the traffic through the policy.
6. Toggle the Enable SNAT switch to the setting you want. If the slider is gray the option is disabled. If it is colored,

it is enabled.
7. Use the drop down menu to select a Protocol. The options are:

l Any
l ICMP
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l IGMP
l TCP - includesPort Range fields
l UDP - includesPort Range fields
l OSPF
l Other - includes a field for the protocol number

8. Depending on which Protocol is defined, the some other fields may appear.
l Port Range - The first field is for the starting value for the port and the second for the ending value for the

port range used by the protocol. Both of these values are inclusive.
l Protocol field - This appears when theOther option is chosen. Enter the value of the protocol number for the

protocol you wish to use.
9. Toggle the Log Allowed Traffic switch to the setting you want. If the slider is gray the option is disabled. If it is

colored, it is enabled.
10. Toggle the Enable this policy switch to the setting you want. If the slider is gray the option is disabled. If it is

colored, it is enabled. By default, this should be enabled
11. Click on theOK button to save the policy.
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Object Configuration

As was mentioned earlier, the components of the FortiGate firewall go together like interlocking building blocks.
The Firewall objects are a prime example of those building blocks. They are something that can be configured
once and then used over and over again to build what you need. They can assist in making the administration of
the FortiGate unit easier and more intuitive as well as easier to change. By configuring these objects with their
future use in mind as well as building in accurate descriptions the firewall will become almost self documenting.
That way, months later when a situation changes, you can take a look at a policy that needs to change and use a
different firewall object to adapt to the new situation rather than build everything new from the ground up to
accommodate the change.

This chapter includes information about the following Firewall objects:

l Addresses
l "Virtual IPs" on page 1085
l IP Pools
l "Services" on page 1097
l "Firewall schedules" on page 1104
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UUID Support
AUniversally Unique Identified (UUID) attribute has been added to some firewall objects, so that the logs can
record these UUID to be used by a FortiManager or FortiAnalyzer unit. The objects currently include:

l Addresses, both IPv4 and IPv6
l Address Groups, both IPv4 and IPv6
l Virtual IPs, both IPv4 and IPv6
l Virtual IP groups, both IPv4 and IPv6
l Policies, IPv4,IPv6 and IP64

A UUID is a 16-octet (128-bit) number that is represented by 32 lowercase hexidecimal digits. The digits are
displayed in five groups separated by hyphens (-). The pattern is 8-4-4-4-12; 36 digits if you include the hyphens.

Note:UUID is only supported on large-partition platforms (>=128M)
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Addresses
Firewall addresses define sources and destinations of network traffic and are used when creating policies. When
properly set up these firewall objects can be used with great flexibility to make the configuration of firewall
policies simpler and more intuitive. The FortiGate unit compares the IP addresses contained in packet headers
with a security policy’s source and destination addresses to determine if the security policy matches the traffic.

The address categories and the types within those categories on the FortiGate unit can include:

l IPv4 addresses
l IP address and Netmask
l IP address range
l Geography based address
l Fully Qualified Domain Name (FQDN) address
l Wildcard FQDN
l IPv4 Address Group

l IPv6 addresses
l Subnets
l IP range
l IPv6 Address Group

l Multicast addresses
l Multicast IP range
l Broadcast subnets

l Proxy Addresses
l URL Pattern
l Host Regex Match
l URL Category
l HttpMethod
l User Agent
l HTTPHeader
l Advanced (Source)
l Advanced (Destination)

l IP Pools (IPv4)
l Overload
l One-to-one
l Fixed Port Range
l Port Block Allocation

l IP Pools (IPv6)
l Virtual IP Addresses

l IPv4
l IPv6
l NAT46
l NAT64
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Interfaces

When setting up an address one of the parameters that is asked for is the interface. This means that the system
will expect to see that address only on the interface that you select. You can only select one interface. If you
expect that the address may be seen at more than one interface you can choose the “any” interface option.
Whenever, possible it is best to choose a more specific interface than the “any” option because in the GUI
configuration of firewall policies there is a drop down field that will show the possible addresses that can be used.
The drop down will only show those addresses that can be on the interface assigned for that interface in the
policy.

Example:

l You have an address called “XYZ”.
l “XYZ” is set to the WAN1 interface because that is the only interface that will be able to access that address.
l When you are selecting a Source Address in the Web-based Manager for a policy that is using the DMZ the address

“XYZ” will not be in the drop-down menu.

When there are only 10 or 20 addresses this is not a concern, but if there are a few hundred addresses configured
it can make your life easier.

Addresses, address groups, and virtual IPs must have unique names to avoid confusion in firewall policies. If an
address is selected in a policy, the address cannot be deleted until it is deselected from the policy.

Addressing Best Practices Tip

The other reason to assign a specific interface to addresses is that it will prevent you
from accidentally assigning an address where it will not work properly. Using the
example from earlier, if the “XYZ” address was assigned to the “Any” interface instead
of WAN1 and you configure the “XYZ” address.

Addressing Best Practices Tip

Don't specify an interface for VIP objects or other address objects that may
need to be moved or approached from a different direction. When
configuring a VIP you may think that it will only be associated with a single
interface, but you may later find that you need to reference it on another
interface.

Example: Some web applications require the use of a FQDN rather than an
IP address. If you have a VIP set up that works from the Internet to the
Internal LAN you wont be able to use that VIP object to access it from an
internal LAN interface.

IPv4 Addresses

When creating an IPv4 address there are a number of different types of addresses that can be specified. These
include:

l FQDN
l Geography
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l IP Range
l IP/Netmask
l Wildcard FQDN

Which one chosen will depend on which method most easily yet accurately describes the addresses that you are
trying to include with as few entries as possible based on the information that you have. For instance, if you are
trying to describe the addresses of a specific company’s web server but it you have no idea of how extensive there
web server farm is you would be more likely to use a Fully Qualified Domain Name (FQDN) rather than a specific
IP address. On the other hand some computers don’t have FQDNs and a specific IP address must be used.

The following is a more comprehensive description of the different types of addresses.

FQDN Addresses

By using Fully Qualified Domain Name (FQDN) addressing you can take advantage of the dynamic ability of DNS
to keep up with address changes without having to manually change the addresses on the FortiGate. FQDN
addresses are most often used with external web sites but they can be used for internal web sites as well if there
is a trusted DNS server that can be accessed. FQDN addressing also comes in handy for large web sites that may
use multiple addresses and load balancers for their web sites. The FortiGate firewall automatically maintains a
cached record of all the addresses resolved by the DNS for the FQDN addresses used.

For example, if you were doing this manually and you wanted to have a security policy that involved Google you
could track down all of the IP addresses that they use across multiple countries. Using the FQDN address is
simpler and more convenient.

When representing hosts by an FQDN, the domain name can also be a subdomain, such as mail.example.com.

Valid FQDN formats include:

l <host_name>.<top_level_domain_name> such as example.com
l <host_name>.<second_level_domain_name>.<top_level_domain_name>, such as mail.example.com

When creating FQDN entries it is important to remember that:

l Wildcards are not supported in FQDN address objects
l While there is a level of convention that would imply it, “www.example.com” is not necessarily the same address of

“example.com”. they will each have their own records on the DNS server.

The FortiGate firewall keeps track of the DNS TTLs so as the entries change on the DNS servers the IP address
will effectively be updated for the FortiGate. As long as the FQDN address is used in a security policy, it stores
the address in the DNS cache.

There is a possible security downside to using FQDN addresses. Using a fully qualified
domain name in a security policy means that your policies are relying on the DNS
server to be accurate and correct. DNS servers in the past were not seen as potential
targets because the thinking was that there was little of value on them and therefore
are often not as well protected as some other network resources. People are becoming
more aware that the value of the DNS server is that in many ways it controls where
users and computers go on the Internet. Should the DNS server be compromised,
security policies requiring domain name resolution may no longer function properly.

Creating a Fully Qualified Domain Name address

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address.
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3. In the Category field, choseAddress. (This is for IPv4 addresses.)
4. Input a Name for the address object.
5. In the Type field, select FQDN from the drop down menu.
6. Input the domain name in the FQDN field.
7. In the Interface field, leave as the default any or select a specific interface from the drop down menu.
8. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled, the address will

appear in drop down menus where it is an option.
9. Input any additional information in the Comments field.
10. PressOK.

Example: FQDN address

You have to great a policy that will govern traffic that goes to a site that has a number of servers on the Internet.
Depending on the traffic or the possibility that one of the servers is down network traffic can go to any one of
those sites. The consistent factor is that they all use the same Fully Qualified Domain Name.

l The FQDN of the web site: example.com
l The number of ISP connections off of the FortiGate firewall: 2

Configuring the address in the GUI

1. Go to Policy & Objects> Objects > Addresses and select Create New > Address.
2. Fill out the fields with the following information:

Category Address

Name BigWebsite.com

Type FQDN

FQDN bigwebsite.com

Interface any

Show in Address List <enable>

Comments <Input into this field is optional>

3. Select OK.

Configuring the address in the CLI

config firewall address
edit BigWebsite.com

set type fqdn
set associated-interface any
set fqdn bigwebsite.com

end

Verification

To verify that the addresses were added correctly:
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1. Go to Firewall Objects > Address > Addresses. Check that the addresses have been added to the address
list and that they are correct.

2. Enter the following CLI command:
config firewall address

edit <the name of the address that you wish to verify>
Show full-configuration

Changing the TTL of a FQDN address

To make sure that the FQDN resolves to the most recent active server you have been asked to make sure that the
FortiGate has not cached the address for any longer than 10 minutes.

There is no field for the cached time-to-live in the web-based manager. It is only configurable in the CLI. Enter the
following commands:

config firewall address
edit BigWebsite.com

set cache-ttl 600
end

Geography Based Addresses

Geography addresses are those determined by country of origin.

This type of address is only available in the IPv4 address category.

Creating a Geography address

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address.
3. In the Category field, choseAddress. (This is for IPv4 addresses.)
4. Input a Namefor the address object.
5. In the Type field, select Geography from the drop down menu.
6. In the Country field, select a single country from the drop down menu.
7. In the Interface field, leave as the default any or select a specific interface from the drop down menu.
8. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled the address will

appear in drop down menus where it is an option.
9. Input any additional information in the Comments field.
10. PressOK.

Example: Geography-based Address

Configuring the address in the GUI

Your company is US based and has information on its web site that may be considered information that is not
allowed to be sent to embargoed countries. In an effort to help reduce the possibility of sensitive information
going to those countries you have be asked to set up addresses for those countries so that they can be block in
the firewall policies.
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l One of the countries you have been asked to block is Cuba
l You have been asked to comment the addresses so that other administrators will know why they have been created

1. Go to Policy & Objects> Objects > Addresses and select Create New > Address.
2. Fill out the fields with the following information

Category Address

Name Cuba

Type Geography

Country Cuba

Interface any

Visibility <enable>

Comments Embargoed

3. Select OK.

Configuring the address in the CLI

Enter the following CLI commands:

config firewall address
edit Cuba

set type geography
set country CN
set interface wan1

end

Overrides

It is possible to assign a specific ip address range to a customized country ID. Generally, geographic addressing
is done at the VDOM level; it could be considered global if you are using the root VDOM, but the geoip-override
setting is a global setting.

config system geoip-override
edit "test"

set country-id "A0"
config ip-range

edit 1
set start-ip 7.7.7.7
set end-ip 7.7.7.8
next

edit 2
set start-ip 7.7.10.1
set end-ip 7.7.10.255
end
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l While the setting exists in the configuration file, the system assigns the country-id
option automatically.

l While you can use "edit 1" and "edit 2", it is simpler to use "edit 0" and let the system
automatically assign an ID number.

After creating a customized Country by using geoip-override command, the New country name has been added
automatically to the country list and will be available on the Firewall Address Country field.

Diagnose commands

There are a few diagnose commands used with geographic addresses. The basic syntax is:

diagnose firewall ipgeo [country-list | ip-list | ip2country | override |
copyright-notice]

Diagnose command Description

country-list Listing of all the countries.

ip-list List of the IP addresses associated with the country

ip2country Used to determine which country a specific IP address is
assigned to.

override Listing of user defined geography data - items configured by
using "config system geoip-override" command.

copyright-notice Shows the copyright notice.

Click on the diagnose command in the table to connect to the Fortinet Diagnose Wiki
page that deals with the command option, to get more information.

IP Range Addresses

Where the Subnet address is good a representing a standardized group of addresses that are subnets the IP
Range type of address can describe a group of addresses while being specific and granular. It does this by
specifying a continuous set of IP addresses between one specific IP address and another. While it is most
common that this range is with a subnet it is not a requirement. For instance, 192.168.1.0/24 and 192.168.2.0/24
would be 2 separate subnets but if you wanted to describe the top half of one and the bottom half of the other you
could describe the range of 192.168.1.128-192.168.2.127. It’s also a lot easier that trying to calculate the correct
subnet mask.

The format would be:

x.x.x.x-x.x.x.x, such as 192.168.110.100-192.168.110.120

There is a notation that is commonly used and accepted by some devices that follows the format:
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x.x.x.[x-x], such as 192.168.110.[100-120]

This format is not recognized in FortiOS 5.2 as a valid IP Range.

Creating a IP Range address

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address
3. In the Category field, chose Address(IPv4 addresses) or IPv6 Address.
4. Input a Name for the address object.
5. In the Type field, select IP Range from the drop down menu.
6. In the Subnet / IP Range field, enter the range of addresses in the following format: x.x.x.x-x.x.x.x (no spaces)
7. In the Interface field, leave as the default any or select a specific interface from the drop down menu. (This

setting is not available for IPv6 addresses)
8. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled the address will

appear in drop down menus where it is an option.
9. Input any additional information in the Comments field.
10. PressOK.

Example

Example of a IP Range address for a group of computers set aside for guests on the company network.

Field Value

Category Address or IPv6 Address

Name Guest_users

Type IP Range

Subnet / IP
Range 192.168.100.200-192.168.100.240

Interface Port1

Show in Address
List [on]

Comments Computers on the 1st floor used by guests for Internet access.

IP Range addresses can be configured forboth IPv4 and IPv6 addresses. The only
differences in creating an IPv6 IP Range address is that you would choose IPv6
Address for the Category and the syntax of the address in the Subnet/IP Range field
would be in the format of 2001:0db8:0000:0002:0:0:0:20-
2001:0db8:0000:0004:0:0:0:20
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IP / Netmask Addresses

The subnet type of address is expressed using a host address and a subnet mask. From a strictly mathematical
stand point this is the most flexible of the types because the address can refer to as little one individual address or
as many as all of the available addresses.

It is usally used when referring to your own internal addresses because you know what they are and they are
usually administered in groups that are nicely differentiated along the lines of the old A, B, and C classes of IPv4
addresses. They are also addresses that are not likely to change with the changing of Internet Service Providers
(ISP).

When representing hosts by an IP address with a netmask, the IP address can represent one or more hosts. For
example, a firewall address can be:

l A single host such as a single computer with the address 192.45.46.45
l A range of hosts such as all of the hosts on the subnet 192.45.46.1 to 192.45.46.255
l All hosts, represented by 0.0.0.0 which matches any IP address

The netmask corresponds to the subnet class of the address being added, and can be represented in either
dotted decimal or CIDR format. The FortiGate unit automatically converts CIDR formatted netmasks to dotted
decimal format. Example formats:

l Netmask for a class A subnet of 16,777,214 usable addresses: 255.0.0.0, or /8
l Netmask for a class B subnet of 65,534 usable addresses: 255.255.0.0, or /16
l Netmask for a class C subnet of 254 usable addresses: 255.255.255.0, or /24
l Netmask for subnetted class C of 126 usable addresses: 255.255.255.128, or /25
l Netmask for subnetted class C of 62 usable addresses: 255.255.255.128, or /26
l Netmask for subnetted class C of 30 usable addresses: 255.255.255.128, or /27
l Netmask for subnetted class C of 14 usable addresses: 255.255.255.128, or /28
l Netmask for subnetted class C of 6 usable addresses: 255.255.255.128, or /29
l Netmask for subnetted class C of 2 usable addresses: 255.255.255.128, or /30
l Netmask for a single computer: 255.255.255.255, or /32
l Netmask used with 0.0.0.0 to include all IP addresses: 0.0.0.0, or /0

So for a single host or subnet the valid format of IP address and netmask could be either:

x.x.x.x/x.x.x.x, such as 192.168.1.0/255.255.255.0

or

x.x.x.x/x, such as 192.168.1.0/24

Static Route Configuration

A setting that is found in the IP/Netmask address type that is not found in the other address types is the enabling
or disabling of Static Route Configuration. Enabling this feature includes the address in the listing of named
addresses when setting up a static route.

To use in the GUI

1. Enable the Static Route Configuration in the address.
2. Go to Network > Static Routes and create a new route.
3. For a Destination type, choose Named Address.
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4. Using the drop down menu, enter the name of the address object in the field just underneath the Destination
type options.

5. Fill out the other information relevant to the route
6. Select theOK button

To enable in the CLI:

config firewall address
edit <address_name>

set allow-routing enable
end

Creating a Subnet address

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address.
3. In the Category field, chose Address. (This is for IPv4 addresses.)
4. Input a Namefor the address object.
5. In the Type field, select IP/Netmask from the drop down menu.
6. In the Subnet/IP Range field, enter the address and subnet mask according to the format x.x.x.x/x.x.x.x or the

short hand format of x.x.x.x/x
7. In the Interface field, leave as the default any or select a specific interface from the drop down menu.
8. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled the address will

appear in drop down menus where it is an option.
9. Select the desired on/off toggle setting for Static Route Configuration.
10. Input any additional information in the Comments field.
11. PressOK.

Example

Example of a Subnet address for a database server on the DMZ:

Field Value

Category Address

Name DB_server_1

Type IP/Netmask

Subnet/IP Range United States

Interface any

Show in Address List [on]

Static Route Configuration [off]

Comments
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Wildcard FQDN

There are a number of companies that use secondary and even tertiary domain names or FQDNs for their
websites. Wildcard FQDN addresses are to ease the administrative overhead in cases where this occurs.
Sometimes its as simple as sites that still use www. as a prefix for their domain name. If you don't know whether
or not the www is being used it's simpler to use a wildcard and include all of the possibilities whether it be
example.com, www.example.com or even ftp.example.com.

The following wildcard character instances are supported in wildcard FQDN addresses:

l "?" character
l "*" character in the middle of a phrase
l The "?*" combination

Wildcard FQDN addresses do not resolve to a specific set of IP addresses in the same
way that a normal FQDN addresss does. They are intended for use in SSL exemptions
and should not be used as source or destination addresses in policies.

Creating a Fully Qualified Domain Name address

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address.
3. In the Category field, chose Address. (This is for IPv4 addresses.)
4. Input a Name for the address object.
5. In the Type field, selectWildcard FQDN from the drop down menu.
6. Input the domain name in theWildcard FQDN field.
7. In the Interface field, leave as the default any or select a specific interface from the drop down menu.
8. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled, the address will

appear in drop down menus where it is an option.
9. Input any additional information in the Comments field.
10. PressOK.

Example

Example of a FQDN address for a remote FTP server used by Accounting team:

Field Value

Category Address

Name Example.com_servers

Type Wildcard FQDN

Wildcard FQDN *.example.com

Interface any
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Field Value

Show in Address List [on]

Comments Secondary and tertiary domain names for example.com

IPv6 Addresses

When creating an IPv6 address there are a number of different types of addresses that can be specified. These
include:

l Subnet
l IP Range - the details of this type of address are the same as the IPv4 version of this type

The IPv6 addresses don't yet have the versatility of the IPv4 address in that they don't have things like geography
based or FQDN address but as IPv6 becomes more mainstream this should change.

Subnet Addresses

The Subnet Address type is one that is only used in reference to IPv6 addresses.It represents an IPv6 address
subnet. This means that the address will likely be a series of hexadecimal characters followed by a double colon,
followed by a "/", and then a number less than 128 to indicate the size of the subnet. An example would be:

fd5e:3c59:35ce:f67e::/64

l The hexidecimal charaters represent the IPv6 subnet address.
l The "::" indicates 0's from that point to the left. In an actual address for a computer, the hexadecimal characters

that would take the place of these zeros would represent the device address on the subnet.
l /xx, in this case /64 represents the number of bits in the subnet.This will make a range that can potentially include

18,446,744,073,709,551,616 addresses. For those wanting to use English rather than math, that is 18 Quintillion.

Creating a Subnet address

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address
3. In the Category field, chose IPv6 Address.
4. Input a Name for the address object.
5. In the Type field, select Subnet from the drop down menu.
6. In the Subnet / IP Range field, enter the range of addresses in IPv6 format (no spaces)
7. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled the address will

appear in drop down menus where it is an option.
8. Input any additional information in the Comments field.
9. PressOK.

Example

Example of a IP Range address for a group of computers set aside for guests on the company network.
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Field Value

Category IPv6 Address

Name IPv6_Guest_user_range

Type Subnet

Subnet / IP Range fd5e:3c59:35ce:f67e::/64

Show in Address List [on]

Comments

Multicast Addresses

Multicast addressing defines a specific range of address values set aside for them. Therefore all IPv4 multicast
addresses should be between 224.0.0.0 and 239.255.255.255.

More information on the concepts behind Multicast addressing can be found in the Multicast Forwarding section.

Multicast IP Range

This type of address will allow multicast broadcasts to a specified range of addresses.

Creating a Multicast IP Range address

1. Go to Policy & Objects > Addresses.
2. Select Create New.

l If you use the down arrow next to Create New, select Address.

3. Choose the Category, Multicast Address
4. Input a Name for the address object.
5. Select the Type,Multicast IP Range from the dropdown menu.
6. Enter the value for theMulticast IP Range
7. Select the Interface from the dropdown menu.
8. Enable the Show in Address List function
9. Input any additional information in the Comments field.
10. PressOK.

Example: Multicast IP Range Address

The company has a large high tech campus that has monitors in many of its meeting rooms. It is common
practice for company wide notifications of importance to be done in a streaming video format with the CEO of the
company addressing everyone at once.
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The video is High Definition quality so takes up a lot of bandwidth. To minimize the impact on the network the
network administrators have set things up to allow the use of multicasting to the monitors for these notifications.
Now it has to be set up on the FortiGate firewall to allow the traffic.

l The range being used for the multicast is 239.5.5.10 to 239.5.5.200
l The interface on this FortiGate firewall will be on port 9

1. Go to Policy & Objects> Objects > Addresses and select Create New > Address.
2. Fill out the fields with the following information

Category Multicast Address

Name Meeting_Room_Displays

Type Multicast IP Range

Multicast IP Range 239.5.5.10-239.5.5.200

Interface port9

Show in Address List <enable>

Comments <Input into this field is optional>

3. Select OK.
4. Enter the following CLI command:

config firewall multicast-address
edit "meeting_room_display"

set type multicastrange
set associated-interface "port9"
set start-ip 239.5.5.10
set end-ip 239.5.5.200
set visibility enable
next

end

To verify that the address range was added correctly:

1. Go to Policy & Objects> Objects > Addresses. Check that the addresses have been added to the address list
and that they are correct.

2. Enter the following CLI command:
config firewall multicast-address

edit <the name of the address that you wish to verify>
Show full-configuration

Broadcast Subnet

This type of address will allow multicast broadcast to every node on a subnet.

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address.
3. In theCategory field, choseMulticast Address.
4. Input a Name for the address object.
5. In the Type field, select Broadcast Subnetfrom the drop down menu.
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6. In the Broadcast Subnet field enter the address and subnet mask according to the format x.x.x.x/x.x.x.x or the
short hand format of x.x.x.x/x.(Remember, it needs to be within the appropriate IP range 224.0.0.0 to
239.255.255.255)

7. In the Interface field, leave as the default any or select a specific interface from the drop down menu.
8. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled the address will

appear in drop down menus where it is an option.
9. Input any additional information in the Comments field.
10. PressOK.

Example

Field Value

Category Broadcast Subnet

Name Corpnet-B

Type Broadcast Subnet

Broadcast Subnet 224.5.5.0/24

Interface any

Show in Address List [on]

Comments Corporate Network devices - Broadcast Group B

Multicast IP addresses

Multicast uses the Class D address space. The 224.0.0.0 to 239.255.255.255 IP address range is reserved for
multicast groups. The multicast address range applies to multicast groups, not to the originators of multicast
packets. The following table lists the reserved multicast address ranges and describes what they are reserved for:

Reserved Multicast address ranges

Reserved
Address Range Use Notes

224.0.0.0 to
224.0.0.255

Used for network protocols on local
networks. For more information, see RFC
1700.

In this range, packets are not forwarded
by the router but remain on the local
network. They have a Time to Live (TTL)
of 1. These addresses are used for
communicating routing information.

224.0.1.0 to
238.255.255.255

Global addresses used for multicasting
data between organizations and across
the Internet. For more information, see
RFC 1700.

Some of these addresses are reserved,
for example, 224.0.1.1 is used for
Network Time Protocol (NTP).
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Reserved
Address Range Use Notes

239.0.0.0 to
239.255.255.255

Limited scope addresses used for local
groups and organizations. For more
information, see RFC 2365.

Routers are configured with filters to
prevent multicasts to these addresses
from leaving the local system.

Creating multicast security policies requires multicast firewall addresses. You can add multicast firewall
addresses by going to Firewall Objects > Address > Addresses and selecting Create New > Multicast
Address. The factory default configuration includes multicast addresses for Bonjour (224.0.0.251-224.0.0.251,
EIGRP (224.0.0.10-224.0.0.100), OSPF (224.0.0.5-224.0.0.60), all_hosts (224.0.0.1-224.0.0.1), and all_routers
(224.0.0.2-224.0.0.2).

Proxy Addresses

This category of address is different from the other addresses in that it is not designed to be used in the normal
firewall policy configuration. It is intended to be used only with explicit web proxies.

In some respects they can be like a FQDN addresses in that they refer to an alpha-numeric string that is assigned
to an IP address, but then goes an additional level of granularity by using additional information and criteria to
further specify locations or types of traffic within the website itself.

Creating an Proxy address

1. Go to Policy & Objects > Addresses.
2. Select Create New. A drop down menu is displayed. Select Address.
3. In the Category field, chose Proxy Address.
4. Input a Name for the address object.
5. For the Type field, select one of the options from the drop down menu.

Within the Explicit Proxy Address category there are 8 types of addresses. Each of these types will have
associated field(s) that also need to have values entered to make the object specific to it's address.

Type = URL Pattern

l In the Host field, choose from drop down menu
l In the URL Path Regex field, enter the appropriate string

Host Regex Match

l In the Host Regex Pattern field, enter the appropriate string

URL Category

l In the Host field, choose from drop down menu
l In the URL Category field, choose from drop down menu

HTTP Method

l In the Host field, choose from drop down menu
l In the Request Method field, choose from drop down menu
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The options are:

l CONNECT
l DELETE
l GET
l HEAD
l OPTIONS
l POST
l PUT
l TRACE

User Agent

l In the Host field, choose from drop down menu
l In the User Agent field, choose from drop down menu

The options are:

l Apple Safari
l Google Chrome
l Microsoft Internet Explorer or Spartan
l Mozilla Firefox
l Other browsers

HTTP Header

l In the Host field, choose from drop down menu
l In the Header Name field, enter the appropriate string value
l In the Header Regex field, enter the appropriate string value

Advanced (Source)

l In the Host field, choose from drop down menu
l In the Request Method field, choose from drop down menu (see HTTP Method type for option list)
l In the User Agent field, choose from drop down menu (see User Agent type for option list)
l In the Header Group table, create, edit or delete Header Name strings and associated Header Regex strings

Advance (Destination)

l In the Host field, choose from drop down menu
l In the Host Regex Pattern field, enter the appropriate string
l In the URL Category field, choose from drop down menu

6. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled the address will
appear in drop down menus where it is an option.

7. Input any additional information in the Comments field.
8. PressOK.
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Proxy Address Groups

To create a Proxy address group:

1. Go to Policy & Objects > Addresses.
2. Click on + Create New to get the drop down menu. Select Address Group.
3. In the Category field, choose Proxy Group.
4. Fill in a descriptive name in theGroup Name field.
5. If you wish, use the Change link to change the Color of icons in the GUI. There are 32 color options.
6. In the Type field, select whether the group will be a Source Group (composed of source addresses) or a

Destination Group (composed of destination addresses).
7. Select anywhere in theMembers field to bring forth the pane of potential members for selection to the group.
8. Select the desired on/off toggle setting for Show in Address List. If the setting is enabled, the address will

appear in drop down menus where it is an option.
9. Input any additional information in the Comments field.
10. Click onOK.

Internet Services

In FortiOS 5.4, support was added for Internet Service objects which could be used with FortiView, Logging,
Routing andWAN Load Balancing. Now they can be added to firewall policies as well.

There is an either or relationship between Internet Service objects and destination
address and service combinations in firewall policies. This means that a destination
address and service can be specified in the policy OR an Internet service, not both.

CLI

The related CLI options/syntax are:
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config firewall policy
edit 1

set internet-service 1 5 10
set internet-service-custom test
set internet-service-negate [enable|disable]

end

GUI

In the policy listing page you will notice that is an Internet Service object is used, it will be found in both the
Destination and Service column.

In the policy editing page the Destination Address, nowDestination field now has two types, Address and
Internet Service.

Address Groups

Address groups are designed for ease of use in the administration of the device. If you have a number of
addresses or address ranges that will commonly be treated the same or require the same security policies, you
can put them into address groups, rather than entering multiple individual addresses in each policy refers to
them.

The use of groups is not required. If you have a number of different addresses you could add them individually to
a policy and the FortiGate firewall will process them just as quickly and efficiently as if they were in a group, but
the chances are that if you have used a group once you could need to use it again and depending on the number
of addresses involved entering them individually for each policy can become tedious and the likelihood of an
address being missed becomes greater. If you have a number of policies using that combination of addresses it is
much easier to add or subtract addresses from the group than to try and remember all of the firewall policies that
combination of addresses was used in. With the group, you only have to make the one edit and it is used by any
firewall policy using that address group.

Because security policies require addresses with homogenous network interfaces, address groups should contain
only addresses bound to the same network interface, or to Any.
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For example, if address 1.1.1.1 is associated with port1, and address 2.2.2.2 is associated with port2, they
cannot be in the same group. However, if 1.1.1.1 and 2.2.2.2 are configured with an interface of Any, they can be
grouped, even if the addresses involve different networks.

There are 3 Categories of Address groups to choose from:

l IPv4 Group
l IPv6 Group
l Proxy Group

You cannot mix different categories of addresses within a group, so whether or not it makes sense from an
administrative purpose to group certain addresses together, if some are IPv4 and some are IPv6, it cannot be
done.

Creating an Address Group

1. Go to Policy & Objects > Addresses.
2. Select the down arrow next to Create New, select Address Group.
3. Choose the Category, that is applicable to the proposed selection of addresses.
4. Input aGroup Name for the address object.
Depending on which Category has been chosen the configurations will differ slightly

IPv4 Group

1. Select the "+" in theMembers field. You can select members of the group from the window that slides out from
the left of the screen. It is possible to select more than 1 entry. Select the “X” icon in the field to remove an entry.

2. Select the desired on/off toggle setting for Show in Address List.
3. Select the desired on/off toggle setting for Static Route Configuration .

IPv6 Group

1. Select the "+" in theMembers field. You can select members of the group from the window that slides out from
the left of the screen. It is possible to select more than 1 entry. Select the “X” icon in the field to remove an entry.

2. Select the desired on/off toggle setting for Show in Address List.

Proxy Group

1. Select which Type, either Source Group orDestination Group.
2. Select the "+" in theMembers field. You can select members of the group from the window that slides out from

the left of the screen. It is possible to select more than 1 entry. Select the “X” icon in the field to remove an entry.
3. Select the desired on/off toggle setting for Show in Address List.

Irrespective of the Category the groups all have the same final configuration options:

1. Input any additional information in the Comments field.
2. PressOK.
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UUID Support

Syntax:

config firewall {address|addres6|addgrp|addgrp6}
edit 1

set uuid <example uuid: 8289ef80-f879-51e2-20dd-fa62c5c51f44>
next

end

Virtual IPs
The mapping of a specific IP address to another specific IP address is usually referred to as Destination NAT.
When the Central NAT Table is not being used, FortiOS calls this a Virtual IP Address, sometimes referred to as a
VIP. FortiOS uses a DNAT or Virtual IP address to map an External IP address to an IP address. This address
does not have to be an individual host, it can also be an address range. This mapping can include all TCP/UDP
ports or if Port Forwarding is enabled it will only refer to the specific ports configured. Because, the Central NAT
table is disabled by default the term Virtual IP address or VIP will be used predominantly.

Virtual IP addresses are typically used to NAT external or Public IP addresses to internal or Private IP addresses.
Using a Virtual IP address between 2 internal Interfaces made up of Private IP addresses is possible but there is
rarely a reason to do so as the 2 networks can just use the IP addresses of the networks without the need for any
address translation. Using a Virtual IP address for traffic going from the inside to the Internet is even less likely to
be a requirement, but it is supported.

Something that needs to be considered when there are multiple Public IP addresses on the external interface(s) is
that when a Virtual IP address is used without Port Forwarding enabled there is a reciprocal effect as far as traffic
flow is concerned. Normally, on a firewall policy where NAT is enabled, for outgoing traffic the internal address is
translated to the Public address that is assigned to the FortiGate, but if there is a Virtual IP address with no port
forwarding enabled, then the Internal IP address in the Mapped field would be translated to the IP address
configured as the External Address in the VIP settings.

Example

l The assigned External address (WAN1) of the FortiGate unit is 172.12.96.3 with a subnet mask of 255.255.255.128
l There is a Virtual IP address set up to map the external address 172.12.96.127 on WAN1 to the internal IP address

of 192.168.1.127
l Port Forwarding is not enabled because you want all allowed traffic going to the external IP address to go to this

server.

In this case any outbound traffic from 192.168.1.127 will go out on WAN1 with the IP address of 172.12.96.127
as the source IP address.

In terms of actually using the Virtual IP address, they would be using in the security policies in the same places
that other addresses would be used, usually as a Destination Address.

UUID Support for VIP

UUID is now supported in for virtual IPs and virtual IP groups. This includes virtual IPs for IPv4, IPv6, NAT46, and
NAT64. To view the UUID for these objects in a FortiGate unit's logs, log-uuid must be set to extended mode,
rather than policy-only (which only shows the policy UUID in a traffic log). UUID can only be configured through
the CLI
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Syntax

config sys global
set log-uuid {disable | policy-only | extended}

end

There is another type of address that the term “virtual IP address” commonly refers to
which is used in load balancing and other similar configurations. In those cases, a
number of devices share a separately created virtual IP address that can be sent to
multiple possible devices. In FortiOS these are referred to as Virtual Servers and are
configured in the “Load Balance” section.

If Central-NAT is enabled in the CLI the GUI will be different.

Instead of VIP Type, the field lable will be DNAT & VIP Type

Instead of IPv4 the option will be IPv4 DNAT

There will also be the addition setting of Source Interface Filter.

Commands to set central-nat:

config system settings
set central-nat [enable | disable]
end

Creating a Virtual IP

1. Go to Policy & Objects > Virtual IPs.
2. Select Create New. A drop down menu is displayed. Select Virtual IP.
3. From the VIP Type options, choose an applicable type based on the IP addressing involved. Which is chosen will

depend on which of the IP version networks is on the external interface of the FortiGate unit and which is on the
internal interface.
The available options are:

l IPv4 - IPv4 on both sides of the FortiGate Unit.
l IPv6 - IPv6 on both sides of the FortiGate Unit.
l NAT46 - Going from an IPv4 Network to an IPv6 Network.
l NAT64 - Going from an IPv6 Network to an IPv4 Network.

4. In the Name field, input a unique identifier for the Virtual IP.
5. Input any additional information in the Comments field.
6. The Color of the icons that represent the object in the GUI can be changed by clicking on the [Change] link and

choosing from the 32 colors.

Because the configuration differs slightly for each type the next steps will be under a separate heading based on
the type of the VIP

Configuring a VIP for IPv4

In the Network section:
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7. If an IPv4 type of Virtual IP, select the Interface setting.
Using the drop down menu for the Interface Field, choose the incoming interface for the traffic.
The IPv4 VIP Type is the only one that uses this field. This is a legacy function from previous versions so that
they can be upgraded without complicated reconfiguration. The External IP address, which is a required field,
tells the unit which interface to use so it is perfectly acceptable to choose "any" as the interface. In some
configurations, if the Interface field is not set to "any" the Virtual IP object will not one of the displayed
options when choosing a destination address.

8. Configure the External IP Address/Range.
There are two fields. If there is a single IP address, use that address in both fields. This will be the address on
the outside of the network that is usually the public address of the server. The format of the address will
depend on the VIP Type option that was selected.

9. Configure theMapped IP Address/Range. This will be the address that the traffic is being directed to.
There are two fields. If there is a single IP address, use that address in both fields. The format of the address
will depend on the VIP Type option that was selected.

In the Optional Filters

10. Disable/Enable theOptional Filters.
If only specific IP addresses and/or services are allowed to be the source for traffic using the VIP, enable the
Optional Filters.

11. To specify an allowed address enter the value in the field labeled Source Address. The value can be formatted
in three different ways.

l Source IP - Use the standard format for a single IP address

l Range - Enter the first and last members of the range

l Subnet - Enter the IP address of the broadcast address for the subnet.
To add additional addresses, click on the "+" below the last field with an address. To subtract an address,
click on the "X" next to the field you wish to delete.

12. To specify an allowed Service, toggle the Services option to enabled. Set the Services parameter by selecting
the field with the "+" in the field. This will slide a window out from the right. Single or multiple options can be
selected by highlighting the services wanted, unless the ALL option is chosen, in which case it will be the only
option. For more information on services, check the Firewall Objects section called Services and TCP ports.

13. Disable/Enable Port Forwarding. If only the traffic for a specific port or port range is being forwarded, enable this
setting.

14. Select the Protocol from
l TCP
l UDP
l SCTP
l ICMP

15. Configure the External Service Port. This is the port(s) on the external interface of the FortiGate (the
destination port in the header of the packets). The first field is for the first port in the range the second is for the
last port in the range. As you enter a value in the first field, the second field will auto populate with the same
number, working on the premise that a single port is common. Just edit the second field to extend the range.

16. Configure the settingMap to Port.This will be the listening port on the device located on the internal side of the
network. It does not have to be the same as the External Service Port. The first field is for the first port in the
range the second is for the last port in the range. As you enter a value in the first field, the second field will auto
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populate with the same number, working on the premise that a single port is common. Just edit the second field to
extend the range.

17. PressOK.

Example

This example is for a VIP that is being used to direct traffic from the external IP address to a web server on the
internal network. The web server is for company use only. The company’s public facing web server already used
port 80 and there is only one IP external IP address so the traffic for this server is being listened for on port 8080
of the external interface and being sent to port 80 on the internal host.

Field Value

VIP Type IPv4

Name Internal_Webserver

Comments Web server with Collaboration tools for Corporate employees

Interface Any

External IP
Address/Range

172.13.100.27 <this would normally be a public IP address>

Mapped IP
Address/Range 192.168.34.150

Optional Filters enabled

Source Address
Filter <list of IP addresses of remote users>

Services enabled with HTTP in the list

Port Forwarding enabled

Map to Port 80 - 80

Configuring a VIP for IPv6

In the Network section:

7. Configure the External IP Address/Range.
There are two fields. If there is a single IP address, use that address in both fields. This will be the address on
the outside of the network that is usually the public address of the server. Enter the address in the standard
IPv6 format.

8. Configure theMapped IP Address/Range. This will be the address that the traffic is being directed to.
There are two fields. If there is a single IP address, use that address in both fields. Enter the address in the
standard IPv6 format.

In the Optional Filters
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9. Disable/Enable theOptional Filters.
If only specific IP addresses and/or services are allowed to be the source for traffic using the VIP, enable the
Optional Filters.

10. To specify an allowed address enter the value in the field labeled Source Address. The value can be formatted
in three different ways.

l Source IP - Use the standard format for a single IP address

l Range - Enter the first and last members of the range

l Subnet - Enter the IP address of the broadcast address for the subnet.
To add additional addresses, click on the "+" below the last field with an address. To subtract an address,
click on the "X" next to the field you wish to delete.

12. Disable/Enable Port Forwarding. If only the traffic for a specific port or port range is being forwarded, enable this
setting.

13. Select the Protocol from
l TCP
l UDP
l SCTP

14. Configure the External Service Port. This is the port(s) on the external interface of the FortiGate (the
destination port in the header of the packets). The first field is for the first port in the range the second is for the
last port in the range. As you enter a value in the first field, the second field will auto populate with the same
number, working on the premise that a single port is common. Just edit the second field to extend the range.

15. Configure the settingMap to Port.This will be the listening port on the device located on the internal side of the
network. It does not have to be the same as the External Service Port. The first field is for the first port in the
range the second is for the last port in the range. As you enter a value in the first field, the second field will auto
populate with the same number, working on the premise that a single port is common. Just edit the second field to
extend the range.

16. PressOK.

Configuring a VIP for NAT46

In the Network section:

7. Configure the External IP Address/Range.
There are two fields. If there is a single IP address, use that address in both fields. This will be the address on
the outside of the network that is usually the public address of the server. Enter the address in the standard
IPv4 format.

8. Configure theMapped IP Address/Range. This will be the address that the traffic is being directed to.
There are two fields. If there is a single IP address, use that address in both fields. Enter the address in the
standard IPv6 format.

In the Optional Filters

9. Disable/Enable theOptional Filters.
If only specific IP addresses and/or services are allowed to be the source for traffic using the VIP, enable the
Optional Filters.

10. To specify an allowed address enter the value in the field labeled Source Address. The value can be formatted
in three different ways.
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l Source IP - Use the standard format for a single IP address

l Range - Enter the first and last members of the range

l Subnet - Enter the IP address of the broadcast address for the subnet.
To add additional addresses, click on the "+" below the last field with an address. To subtract an address,
click on the "X" next to the field you wish to delete.

12. Disable/Enable Port Forwarding. If only the traffic for a specific port or port range is being forwarded, enable this
setting.

13. Select the Protocol from
l TCP
l UDP

14. Configure the External Service Port. This is the port(s) on the external interface of the FortiGate (the
destination port in the header of the packets). The first field is for the first port in the range the second is for the
last port in the range. As you enter a value in the first field, the second field will auto populate with the same
number, working on the premise that a single port is common. Just edit the second field to extend the range.

15. Configure the settingMap to Port.This will be the listening port on the device located on the internal side of the
network. It does not have to be the same as the External Service Port. The first field is for the first port in the
range the second is for the last port in the range. As you enter a value in the first field, the second field will auto
populate with the same number, working on the premise that a single port is common. Just edit the second field to
extend the range.

16. PressOK.

Configuring a VIP for NAT64

In the Network section:

7. Configure the External IP Address/Range.
There are two fields. If there is a single IP address, use that address in both fields. This will be the address on
the outside of the network that is usually the public address of the server. Enter the address in the standard
IPv6 format.

8. Configure theMapped IP Address/Range. This will be the address that the traffic is being directed to.
There are two fields. If there is a single IP address, use that address in both fields. Enter the address in the
standard IPv4 format.

In the Optional Filters

9. Disable/Enable theOptional Filters.
If only specific IP addresses and/or services are allowed to be the source for traffic using the VIP, enable the
Optional Filters.

10. To specify an allowed address enter the value in the field labeled Source Address. The value can be formatted
in three different ways.

l Source IP - Use the standard format for a single IP address

l Range - Enter the first and last members of the range

l Subnet - Enter the IP address of the broadcast address for the subnet.
To add additional addresses, click on the "+" below the last field with an address. To subtract an address,
click on the "X" next to the field you wish to delete.
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12. Disable/Enable Port Forwarding. If only the traffic for a specific port or port range is being forwarded, enable this
setting.

13. Select the Protocol from
l TCP
l UDP

14. Configure the External Service Port. This is the port(s) on the external interface of the FortiGate (the
destination port in the header of the packets). The first field is for the first port in the range the second is for the
last port in the range. As you enter a value in the first field, the second field will auto populate with the same
number, working on the premise that a single port is common. Just edit the second field to extend the range.

15. Configure the settingMap to Port.This will be the listening port on the device located on the internal side of the
network. It does not have to be the same as the External Service Port. The first field is for the first port in the
range the second is for the last port in the range. As you enter a value in the first field, the second field will auto
populate with the same number, working on the premise that a single port is common. Just edit the second field to
extend the range.

16. PressOK.

FQDN in VIPs

Instead of mapping to an IP address a VIP can use a FQDN(Fully Qualified Domain Name). This has to be
configured in the CLI and the FQDNmust be an address object that is already configured in the address listing.

The syntax for using a FQDN is:

config firewall vip
edit <VIP id>

set type fqdn
set mappped-addr <FQDN address object>
end

Dynamic VIP according to DNS translation

When a dynamic virtual IP is used in a policy, the dynamic DNS translation table is installed along with the
dynamic NAT translation table into the kernel. All matched DNS responses will be translated and recorded
regardless if they hit the policy. When a client request hits the policy, dynamic NAT translation will occur if it
matches a record, otherwise the traffic will be blocked.

Syntax

config firewall vip
edit "1"

set type dns-translation
set extip 192.168.0.1-192.168.0.100
set extintf "dmz"
set dns-mapping-ttl 604800
set mappedip "3.3.3.0/24" "4.0.0.0/24"
end

end

Virtual IP Groups

Just like other address, Virtual IP addresses can be organized into groups for ease of administration. If you have
multiple virtual IPs that are likely to be associated to common firewall policies rather than add them individually to
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each of the policies you can add the instead. That way, if the members of the group change then any changes
made to the group will propagate to all of the policies using that group.

When using a Virtual IP address group the firewall policy will take into account all of the configured parameters of
the Virtual IPs: IP addresses, Ports and port types.

Creating a Virtual IP Group

1. Go to Policy & Objects > Virtual IPs.
2. Select Create New. A drop down menu is displayed. Select Virtual IP Group.
3. Select the Type fo VIP group you wish to create.

The options available are:
l IPv4 - IPv4 on both sides of the FortiGate Unit.
l IPv6 - IPv6 on both sides of the FortiGate Unit.
l NAT46 - Going from an IPv4 Network to an IPv6 Network.
l NAT64 - Going from an IPv6 Network to an IPv4 Network.

Which is chosen will depend on which of the IP version networks is on the external interface of the
FortiGate unit and which is on the internal interface. The options will be:

4. Enter a unique identifier for the group in the Name field.
5. Enter any additional information in the Comments field.
6. If you wish, use the Change link to change the Color of icons in the GUI. There are 32 color options.
7. If the Type is IPv4, the Interface field will be available. Use the drop-down menu to select the interface if all of

the VIPs are on the same interface. If any of the VIPS are on different interfaces or if any of them are associated
with the "any" option, choose the any option for the group.

8. Select anywhere in theMembers field to bring forth the pane of potential members for selection to the group.
9. PressOK.

Configuring IP pools
An IP pool is essentially one in which the IP address that is assigned to the sending computer is not known until
the session is created, therefore at the very least it will have to be a pool of at least 2 potential addresses. A quick
example would be an IP pool for users of a VPN. IP pools are based upon the version of IP determined by the
interface that they are associated with so as expected there are two types of IP pools that can be configured:

l "Creating a IPv4 Pool" on page 1092
l "Creating a IPv6 Pool" on page 1096

Because of the differences in the configuration for the two types of pools, instructions for configuring them will be
done separately.

Creating a IPv4 Pool

1. Go to Policy & Objects > IP Pools.
2. Select Create New.
3. In the IP Pool Type field choose IPv4 Pool
4. Enter a name in the Name field for the new service
5. Include any description you would like in the Comments field
6. In the Type field choose between:
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l Overload
l One-to-One
l Fixed Port Range
l Port Block Allocation

At this point the configurations can start to differ based on the type of type of pool.

For more information on the different types of IP pools, check IP Pools in the Concepts section.

Overload

7. For the External IP Range fields, enter the lowest and highest addresses in the range. If you only want a single
address used, enter the same address in both fields.

8. Enable the ARP Reply field by making sure there is a check in the box
9. Select OK

Overload Example for GUI

In this example, the Sales team needs to connect to an Application Service Provider that does the accounting for
the company. As a security measure, the ASP only accepts traffic from a white list of IP addresses. There is 1
public IP address of the company on that list.The Sales team consists of 40 people, so they need to share.The
external interface is wan1.

Field Value

IP Pool Type IPv4 Pool

Name Sales_Team

Comments For the Sales team to use to connect to the Accounting ASP

Type Overload (This is the default)

External IP Range 10.23.56.20 - 10.23.56.20

ARPReply enabled

Overload Example for CLI

config firewall ippool
edit Sales_Team

set comments "For the Sales team to use to connect to the Accounting ASP"
set type overload
set startip 10.23.56.20
set endip 10.23.56.20
set arp-reply enable
set arp-intf wan1
end

One-to-one

7. For the External IP Range fields, enter the lowest and highest addresses in the range. If you only want a single
address used, enter the same address in both fields.
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8. Enable the ARP Reply field by making sure there is a check in the box.
9. Select OK

One-to-one Example for GUI

In this example, the external IP address of the mail server is part of a range assigned to the company but not the
one that is assigned to the Internet facing interface. A VIP has been set up but in order to properly resolve
Reverse DNS lookups the mail server always has to use a specific IP address.The external interface is wan1.

Field Value

IP Pool Type IPv4 Pool

Name Mail-Server

Comments So the the correct IP address is resolved on Reverse DNS look ups of the mail server.

Type One-to-one

External IP Range 10.23.56.21 - 10.23.56.21

ARPReply enabled

One-to-one Example for CLI

config firewall ippool
edit Mail-Server

set comments "So the the correct IP address is resolved on reverse DNS look ups of
the mail server."

set type one-to-one
set startip 10.23.56.21
set endip 10.23.56.21
set arp-reply enable
set arp-intf wan1
end

Fixed Port Range

7. For the External IP Range fields, enter the lowest and highest addresses in the range. If you only want a single
address used, enter the same address in both fields.

8. Fort the Internal IP Range fields, enter the lowest and highest addresses in the range.
9. Enable the ARP Reply field by making sure there is a check in the box
10. Select OK

Fixed Port Range Example for GUI

In this example, the company has a range of 10 IP address that they want to be used by employees on a specific
subnet for NATing.The external interface is wan1.
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Field Value

IP Pool Type IPv4 Pool

Name IPPool-3

Comments IP range to be used by outgoing traffic

Type Fixed Port Range

External IP Range 10.23.56.22 - 10.23.56.31

Internal IP Range 192.168.23.1 - 192.168.23.254

ARPReply enabled

Fixed Port Range Example for CLI

config firewall ippool
edit IPPool-3

set comments "So the the correct IP address is resolved on reverse DNS look ups of
the mail server."

set type fixed-port-range
set startip 10.23.56.22
set endip 10.23.56.31
set source-startip 192.168.23.1
set source-endip 192.168.23.254
set arp-reply enable
set arp-intf wan1
end

Port Block Allocation

7. For the External IP Range fields, enter the lowest and highest addresses in the range. If you only want a single
address used, enter the same address in both fields.

8. In the Block Size field, either type in the value or use the up or down arrows to set the value of the block size.
9. In the Blocks Per User field, either type in the value or use the up or down arrows to set the value for the number

of blocks per user.
10. Enable the ARP Reply field by making sure there is a check in the box
11. Select OK

Port Block Allocation Example for GUI

In this example,an small ISP is setting up NATing for its clients, but to be fair it is putting some restrictions on the
number of connections each client can have so that no one hogs all of the possible ports and addresses.The
external interface is port12.

Field Value

IP Pool Type IPv4 Pool

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1095



Object Configuration Chapter 9 - Firewall

Field Value

Name Client-IPPool

Comments IP Pool for clients to access the Internet

Type Port Block Allocation

External IP Range 10.23.75.5 - 10.23.75.200

Block Size 64

Blocks Per User 8

ARPReply enabled

Port Block Allocation Example for CLI

config firewall ippool
edit Client-IPPool

set comments "IP Pool for clients to access the Internet"
set type port-block-allocation
set startip 10.23.75.5
set endip 10.23.75.200
set block-size 64
set num-blocks-per-user 8
set permit-any-host disable
set arp-intf wan1
set arp-reply enableset
arp-intf port12
end

Creating a IPv6 Pool

1. Go to Policy & Objects > IP Pools.
2. Select Create New.
3. In the IP Pool Type field choose IPv6 Pool
4. Enter a name in the Name field for the new service
5. Include any description you would like in the Comments field
6. For the External IP Range fields, enter the lowest and highest addresses in the range.

IPv6 Example for GUI

In this example,there is a similar situation to the One-to-one example earlier.There is a mail server that needs to
be resolved to a specific IP address in Reverse DNS look-ups. The difference in this case is the company is an
early adopter of IPv6 connectivity to the Internet.

Field Value

IP Pool Type IPv6 Pool
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Field Value

Name Mail-svr-ipv6

Comments Registered IPv6 address for mail server

External IP Range fd2f:50ec:cdea:0663::1025 - fd2f:50ec:cdea:0663::1025

Port Block Allocation Example for CLI

config firewall ippool6
edit Mail-svr-ipv6

set comments "Registered IPv6 address for mail server"
set startip fd2f:50ec:cdea:663::102
set endip fd2f:50ec:cdea:663::1025
end

Services
While there are a number of services already configured within FortiOS, the firmware allows for administrators to
configure there own. The reasons for doing this usually fall into one or more of the following categories:

l The service is not common enough to have a standard configuration
l The service is not established enough to have a standard configuration
l The service has a standard port number but there is a reason to use a different one:

l Port is already in use by another service
l For security reasons, want to avoid standard port

When looking at the list of preconfigured services it may seem like there are a lot, but keep in mind that the
theoretical limit for port numbers is 65,535. This gives a fairly good sized range when you are choosing what port
to assign a service but there are a few points to keep in mind.

l Most of the well known ports are in the range 0 - 1023
l Most ports assigned by the Internet Corporation for Assigned Names and Numbers (ICANN) will be in the 1024 -

49151 range
l Port numbers between 49,152 and 65,535 are often used for dynamic, private or ephemeral ports.

There are 3 Service objects that can be added and configured:

l Categories
l Services
l Service Groups

Categories

In order to make sorting through the services easier, there is a field to categorize the services. Because selecting
a category is part of the process for creating a new service, the configuration of categories will be explained first.

The services can be sorted into the following groups:

l General
l Web Access
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l File Access
l Email
l Network Services
l Authentication
l Remote Access
l Tunneling
l VoIP, Messaging and Other Applications
l Web Proxy
l Uncategorized

The categories are for organization purposes so there is not many settings when creating a new one.

Creating a new Service Category

1. Go to Policy & Objects > Services.
2. Select Create New. A drop down menu is displayed. Select Category
3. Input a Name for the category.
4. Input any additional information in the Comments field.
5. PressOK.

Example

You plan on adding a number of devices such as web cameras that will allow the monitoring of the physical
security of your datacenter. A number of non-standard services will have to be created and you would like to keep
them grouped together under the heading of “Surveillance”

Example of a New Category in the GUI

1. Go to Policy & Objects > Objects > Services and select Create New > Category.
2. Fill out the fields with the following information

Field Value

Name Surveillance

Comments For DataCenter Surveillance Devices

3. Select OK.

Example of a New Category in the CLI

Enter the following CLI command:

config firewall service category
edit Surveillance

set comment "For DataCenter Surveillance Devices"
end
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To verify that the category was added correctly:

1. Go to Policy & Objects > Objects > Services. Select the Category Settings icon . A listing of the categories
should be displayed.

2. Enter the following CLI command:
config firewall service category

show

This should bring up all of the categories. Check to see that the new one is displayed.

Configuring a new service

Occasionally, the preconfigured list of services will not contain the needed service. There are a few variations in
the creation of a service depending upon the protocol type, but the first steps in the creation of the service are
common to all the variations.

To create a new service:

1. Go to Policy & Objects > Services.
2. Select Create New. A drop down menu is displayed. Select Service
3. Enter a name in the Name field for the new service
4. Include any description you would like in the Comments field
5. In the Service Type field choose between Firewall and Explicit Proxy.
6. Enable the toggle in the Show in Service List. If you can't see the service when you need to select it, it serves

very little purpose.
7. For the Category field, choose the appropriate category from the Category drop down menu. If none is chosen,

the Uncategorized option will be chosen by default.

Protocol Options

This is the section where the configuration options of the service will differ depending on the type of protocol
chosen. (The Step numbers will all continue on from the common step sequence).

The protocol options for Firewall service type are:

l TCP/UDP/SCTP
l ICMP
l ICMP6
l IP

The protocol options for Proxy service type are:

l ALL
l CONNECT
l FTP
l HTTP
l SOCKS-TCP
l SOCKS-UDP
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TCP/UDP/SCTP

8. For the Protocol Type field, choose TCP/UDP/SCTP from the drop down menu
9. For the Address field, choose IP Range or FQDN (Fully Qualified Domain Name) if there is to be a specific

destination for the service. Depending on which type of address is selected, the field value needs to be filled with a
FQDN string or an IP address in one of the 3 standard IPv4 address formats:
l x.x.x.x - for a specific address
l x.x.x.x/x - for a subnet
l x.x.x.x-x.x.x.x - for a range of specific addresses

10. Configure the Destination Port by:
l Select from the drop down menu, TCP, UDP or SCTP
l Enter the low end to the port range in the field indicated by grayed out Low.
l Enter the high end of the port range in the field indicated by grayed out High. If there is only a single port in the

range High can be left empty
l Multiple ports or port ranges can be added by using the "+" at the beginning of the row
l Rows can be removed by using the trash can symbol at the end of the row

11. If required, you can Specify Source Ports for the service by enabling the toggle switch.
l The Src Portwill match up with a Destination Port
l Src Ports cannot be configured without there being a value for the Destination Port
l The same rules for configuring the Destination Ports applies to the Src Ports

12. Select OK to confirm the configuration

Example

Example settings for a TCP protocol service. In this case, it is for an administrative connection to web servers on
the DMZ. The protocol used is HTTPSwhich would normally use port 443, but that is already in use by another
service such as Admin access to the firewall or an SSL-VPN connection.

Field Value

Name Example.com_WebAdmin

Comments Admin connection to Example.com Website

Service Type Firewall

Show in Service List enabled

Category Web Access

Protocol Options

Protocol Type TCP/UDP/SCTP

IP/FQDN <left blank>
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Field Value

Destination Port l Protocol: TCP
l Low: 4300
l High: <left blank>

Specify Source Ports <disabled>

Creating a new TCP/UDP/SCTP service in the CLI

The following is the creation of the same service using the command line.

config firewall service custom
edit Example.com_WebAdmin

set comment "Admin connection to Example.com Website"
set category Web Access
set protocol TCP/UDP/SCTP
set tcp-portrange 4300
end

end

ICMP / ICMP6

8. For the Protocol Type field, choose ICMP or ICMP6 from the drop down menu
9. In the Type field enter the appropriate type number based on the information found in "ICMP Types and Codes"

on page 1 or in "ICMPv6 Types and Codes" on page 1, depending on whether the Protocol Type is ICMP or
ICMPv6

10. In the Code field enter the appropriate code number for the type, if applicable, based on the information found in
"ICMP Types and Codes" on page 1 or in "ICMPv6 Types and Codes" on page 1, depending on whether the
Protocol Type is ICMP or ICMPv6

11. Select OK to confirm the configuration

Example

Example settings for an ICMP.service.In this case it has been set up for some special testing of ICMP packets.

Field Value

Name ICMP test #4

Comments For testing of proprietary network scanner

Service Type Firewall

Show in Service List enabled

Category Network Services

Protocol Options
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Field Value

Protocol Type ICMP

Type 7

Code <left blank>

Creating a new ICMP service in the CLI

The following is the creation of the same service using the command line.

config firewall service custom
edit ICMP test4

set comment "For testing of proprietary network scanner"
set category Network Services
set protocol ICMP
set icmptype 7
end

end

IP

8. For the Protocol Type field, choose IP from the drop down menu
9. In the Protocol Number field enter the numeric value based on the information found in "Protocol Number" on

page 1
10. Select OK to confirm the configuration

Example

Example settings for an IP.service.In this case it has been set up to communicate via an old protocol called QNX

Field Value

Name QNX

Comments For QNX communications to the Development Lab

Service Type Firewall

Show in Service List enabled

Category Uncatagorized

Protocol Options

Protocol Type IP

Protocol Number 106
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Creating a new ICMP service in the CLI

The following is the creation of the same service using the command line.

config firewall service custom
edit ICMP test4

set comment "For QNX communications to the Development Lab "
set protocol IP
set icmptype 106
end

end

In the CLI examples, the fields for Show in Service List, Service Type and in the
example for IP, Categorywere net set because the values that they would have been
set to were the default values and were already correctly set.

ALL/CONNECT/FTP/HTTP/SOCKS-TCP/SOCKS-UDP

These options are available only if the Service Type is set to Explicit Proxy.

8. For the Protocol Type field, choose one of the following from the drop down menu:
l ALL
l CONNECT
l FTP
l HTTP
l SOCKS-TCP
l SOCKS-UDP

9. For the Address field, choose IP Range or FQDN (Fully Qualified Domain Name) if there is to be a specific
destination for the service. Depending on which type of address is selected, the field value needs to be filled with a
FQDN string or an IP address in one of the 3 standard IPv4 address formats:
l x.x.x.x - for a specific address
l x.x.x.x/x - for a subnet
l x.x.x.x-x.x.x.x - for a range of specific addresses

10. Configure the Destination Port by:
l Enter the low end to the TCP port range in the field indicated by grayed out Low.
l Enter the high end of the TCP port range in the field indicated by grayed out High. If there is only a single port

in the range High can be left empty
l Multiple ports or port ranges can be added by using the "+" at the beginning of the row
l Rows can be removed by using the trash can symbol at the end of the row

11. If required, you can Specify Source Ports for the service by enabling the toggle switch.
l The Src Portwill match up with a Destination Port
l Src Ports cannot be configured without there being a value for the Destination Port
l The same rules for configuring the Destination Ports applies to the Src Ports

12. Select OK to confirm the configuration
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Specific Addresses in TCP/UDP/SCTP

In the TCP/UDP/SCTP services it is also possible to set the parameter for a specific IP or Fully Qualified Domain
Name address. The IP/FQDN field refers to the destination address of the traffic, not the source. This means for
example, that you can set up a custom service that will describe in a policy the TCP traffic over port 80 going to
the web site example.com, but you cannot set up a service that describes the TCP traffic over port 80 that is
coming from the computer with the address 192.168.29.59.

Service Groups

Just like some of the other firewall components, services can also be bundled into groups for ease of
administration.

Creating a ServiceGroup

1. Go to Policy & Objects > Services.
2. Select Create New. A drop down menu is displayed. Select Service Group
3. Input aGroup Name to describe the services being grouped
4. Input any additional information in the Comments field.
5. Choose a Type of group.The options are Firewall or Explicit Proxy.
6. Add to the list of Members from the drop down menu. Using the + sign beside the field will allow the addition of

multiple services.
7. PressOK.

Example

Example of a New Service Group:

Field Value

Group Name Authentication Services

Comments Services used in Authentication

Type Firewall

Members

l Kerberos
l LDAP
l LDAP_UDP
l RADIUS

Firewall schedules
Firewall schedules control when policies are in effect. When you add a security policy on a FortiGate unit you
need to set a schedule to determine the time frame in which that the policy will be functioning. While it is not set
by default, the normal schedule would be always. This would mean that the policy that has been created is
always function and always policing the traffic going through the FortiGate. The time component of the schedule
is based on a 24 hour clock notation or military time as some people would say.

There are two types of schedules: One-time schedules and recurring schedules.
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One-time schedule object

One-Time schedules are in effect only once for the period of time specified in the schedule. This can be useful
for testing to limit how long a policy will be in effect in case it is not removed, or it can be used for isolated events
such as a conference where you will only need a temporary infrastructure change for a few days.

The time frame for a One-time schedule is configured by using a start time which includes, Year | Month | Day |
Hour | Minute and a Stop time which includes the same variables. So while the frequency of the schedule is only
once it can last anywhere from 1 minute to multiple years.

Configuring a One-time schedule object in the GUI

1. Go to Policy & Objects > Schedules.
2. Select Create New. A drop down menu is displayed. Select Schedule.
3. From the Type options, chooseOne-time.
4. Input a Name for the schedule object.
5. If you which to add a Color to the icon in the GUI, you can click on the Change link to choose 1 of 32 color

options.
6. Choose a Start Date.

Selecting the field with the mouse will bring up a interactive calendar graphic that will allow the user to select
the date. The date can also be typed in using the format YYYY/MM/DD.

7. Choose a Start Time.
The Start Time is composed of two fields, Hour andMinute. Think of setting the time for a digital clock in
24 hour mode. The Hour value can be an integer from 0 and 23. TheMinute value can be from 0 to 59. 0
and 0 would be midnight at the start of the day and 23 and 59 would be one minute to midnight at the end of
the day. The value can be entered by keyboard or by using the up and down arrows in the field to select the
value.

6. Choose an End Date.
Configuration is the same asStart Date.

8. Choose a Stop Time.
Configuration is the same asStart Time.

9. Enable/Disable Pre-expiration event log.
This configures the system to create an event log 1 to 100 days before the End Date as a warning in case
the schedule needs to be extended.

10. If the Pre-expiration event log is enabled, set the value forNumber of days before.
11. PressOK.

Example: Firewall Schedule - One-time

The company wants to change over their web site image to reference the new year. They have decided to take
this opportunity to do some hardware upgrades as well. Their web site is business oriented so they have
determined that over New Year’s Eve there will be very limited traffic.

l They are going to need a maintenance window of 2 hours bracketing midnight on New Year’s Eve.
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Configuration in the GUI

1. Go to Policy & Objects > Objects > Schedule.
2. Select Create New > Schedule.
3. Fill out the fields with the following information:

Type One-time

Name NewYearsEve_Maintenance

Start Date 2014/12/31 <use the built in calendar>

End Date 2015/01/01 <use the built in calendar>

Start Time Hour: 23, Minute: 0

Stop Time Hour: 1Minute: 0

Pre-expiration event log <disable>

4. Select OK.

To verify that the schedule was added correctly:

1. Go to Policy & Objects > Objects > Schedule.
2. Check that the schedule with the name you used has been added to the list of recurring schedules and that the

listed settings are correct.

Configuration in the CLI

1. Enter the following CLI command:
config firewall schedule onetime

edit maintenance_window
set start 23:00 2012/12/31
set end 01:00 2013/01/01
next

end

To verify that the schedule was added correctly:

1. Enter the following CLI command:
config firewall schedule onetime

edit <the name of the schedule you wish to verify>
show full-configuration

Recurring schedule object

Recurring schedules are in effect repeatedly at specified times of specified days of the week. The Recurring
schedule is based on a repeating cycle of the days of the week as opposed to every x days or days of the month.
This means that you can configure the schedule to be in effect on Tuesday, Thursday, and Saturday but not every
2 days or on odd numbered days of the month.
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If a recurring schedule has a stop time that is earlier than the start time, the schedule will take effect at the start
time but end at the stop time on the next day. You can use this technique to create recurring schedules that run
from one day to the next.

Configuring a Recurring schedule object in the GUI

1. Go to Policy & Objects > Schedules.
2. Select Create New. A drop down menu is displayed. Select Schedule.
3. From the Type options, choose Recurring.
4. Input a Name for the schedule object.
5. If you which to add a Color to the icon in the GUI, you can click on the Change link to choose 1 of 32 color

options.
6. From the Days options, choose the day of the week that you would like this schedule to apply to. The schedule

will be in effect on the days of the week that have a check mark in the checkbox to the left of the name of the
weekday.

7. If the scheduled time is the whole day, leave the All Day toggle switch enabled. If the schedule is for specific
times during the day, disable the All Day toggle switch.

8. If the All Day option is disabled, choose a Start Time.
The Start Time is composed of two fields, Hour andMinute. Think of setting the time for a digital clock in
24 hour mode. The Hour value can be an integer from 0 and 23. TheMinute value can be from 0 to 59. 0
and 0 would be midnight at the start of the day and 23 and 59 would be one minute to midnight at the end of
the day. The value can be entered by keyboard or by using the up and down arrows in the field to select the
value.

7. Choose a Stop Time.
Configuration is the same asStart Time.

8. PressOK.

Because recurring schedules do not work with DENY policies, the strategy when
designing a schedule should not be to determine when users cannot access a policy
but to build the schedules around when it is possible to access the policy.

Example: Firewall Schedule - Recurring

The Company wants to allow the use of Facebook by employees, but only during none business hours and the
lunch break.

l The business hours are 9:00 p.m. to 6:00 p.m.
l The Lunch break is 12:00 p.m. to 1:00 p.m.
l The plan is to create a schedule to cover the morning business hours and the afternoon business hours and block

access to the Facebook web site during that time.

Configuration in the GUI

1. Go to Policy & Objects > Objects > Schedule.
2. Select Create New > Schedule.
3. Fill out the fields with the following information:
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Type Recurring

Name Morning_Business_Hours

Days Monday, Tuesday, Wednesday, Thursday, Friday

Start Time Hour = 9, Minute = 0

Stop Time Hour = 12, Minute = 0

4. Select OK.

5. Create a second new schedule.

Type Recurring

Name Morning_Business_Hours

Days Monday, Tuesday, Wednesday, Thursday, Friday

Start Time Hour = 13, Minute = 0

Stop Time Hour = 18, Minute = 0

6. Select OK.

To verify that the schedule was added correctly:

1. Go to Policy & Objects > Objects > Schedule.
2. Check that the schedule with the name you used has been added to the list of recurring schedules and that the

listed settings are correct.

Configuration in the CLI

1. Enter the following CLI command:
config firewall schedule recurring

edit Morning_Business_Hours
set day monday tuesday wednesday thursday friday
set start 09:00
set end 12:00

end

2. Enter the following CLI command:
config firewall schedule recurring

edit Afternoon_Business_Hours
set day monday tuesday wednesday thursday friday
set start 13:00
set end 18:00

end

To verify that the schedule was added correctly:

1. Enter the following CLI command:
config firewall schedule recurring

edit <the name of the schedule you wish to verify>
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show full-configuration

Schedule Groups

You can organize multiple firewall schedules into a schedule group to simplify your security policy list. The
schedule parameter in the policy configuration does not allow for the entering of multiple schedules into a single
policy so if you have a combination of time frames that you want to schedule the policy for then the best
approach, rather than making multiple policies is to use a schedule group.

Creating a Schedule Group object

1. Go to Policy & Objects > Schedules.
2. Select Create New. A drop down menu is displayed. Select Schedule Group
3. Input a Name for the schedule object.
4. In theMembers field, select the "+" to bring forth the panel for selecting entries.
5. PressOK.

Example

Your Internet policy allows employees to visit Social Media sites from company computers but not during what is
considered working hours. The offices are open a few hours before working hours and the doors are not locked
until a few hours after official closing so work hours are from 9 to 5 with a lunch break from Noon to 1:00 p.m.

Your approach is to block the traffic between 9 and noon and between 1:00 p.m. and 5:00 p.m. This means you
will need two schedules for a single policy and the schedule group handles this for you. Schedule groups can
contain both recurring and one-time schedules. Schedule groups cannot contain other schedule groups.

Schedule expiration

The schedule in a security policy enables certain aspects of network traffic to occur for a specific length of time.
What it does not do however, is police that time. That is, the policy is active for a given time frame, and as long as
the session is open, traffic can continue to flow.

For example, in an office environment, Skype use is allowed between noon and 1pm. During that hour, any Skype
traffic continues. As long as that session is open, after the 1pm end time, the Skype conversations can continue,
yet new sessions will be blocked. Ideally, the Skype session should close at 1pm.

Using a CLI command you can set the schedule to terminate all sessions when the end time of the schedule is
reached. Within the config firewall command enter the command:

set schedule-timeout enable

By default, this option is set to disable.

A few further settings are needed to make this work.

config firewall policy
edit ID

set firewall-session-dirty check-new
end

config system settings
set firewall-session-dirty check-policy-option

end
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The Policy window will indicate when a policy has become invalid due to its schedule
parameters referring only to times in the past.

Firewall-session-dirty setting

The firewall-session-dirty setting has three options

check-all CPU flushes all current sessions and re-evaluates them. [default]

check-new CPU keeps existing sessions and applies policy changes to new sessions only.
This reduces CPU load and the possibility of packet loss.

check-policy-option Use the option selected in the firewall-session-dirty field of the firewall policy
(check-all or check-new, as above, but per policy).

Secure Web Gateway, WAN Optimization, Web Caching and WCCP

You can use FortiGate WAN optimization and web caching to improve performance and security of traffic passing
between locations on your wide area network (WAN) or from the Internet to your web servers. You can also use
the FortiGate unit as an explicit FTP and web proxy server. If your FortiGate unit supports web caching, you can
also add web caching to any HTTP sessions including WAN optimization, explicit web proxy and other HTTP
sessions.

the next sections of this document describes how FortiGate WAN optimization, web caching, explicit web proxy,
explicit FTP proxy and WCCPwork and also describes how to configure these features.

Before you begin
Before you begin to configure WAN optimization, Web caching, explicit proxies or WCCP, take a moment to note
the following:

FortiGate models that support WAN optimization
WAN optimization is available on FortiGate models with internal storage that also support SSL acceleration.
Internal storage includes high-capacity internal hard disks, AMC hard disk modules, FortiGate Storage Modules
(FSMs) or over 4 Gbytes of internal flash storage. All of these storage locations can provide similar web caching
and byte caching performance. If you add more than one storage location (for example, by creating multiple
partitions on a storage device, by using more than one FSM, or by using an FSM and AMC hard disk in the same
FortiGate unit) you can configure different storage locations for web caching and byte caching.

Distributing WAN optimization, explicit proxy, and web caching to multiple CPU Cores
By default WAN optimization, explicit proxy and web caching is handled by half of the CPU cores in a FortiGate
unit. For example, if your FortiGate unit has 4 CPU cores, by default two will be used for WAN optimization,

1110 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 9 - Firewall Secure Web Gateway, WAN Optimization, Web Caching and WCCP

explicit proxy and web caching. You can use the following command to change the number of CPU cores that are
used.

config system global
set wad-worker-count <number>

end

The value for <number> can be between 1 and the total number of CPU cores in your FortiGate unit. Adding
more cores may enhance WAN optimization, explicit proxy and web caching performance and reduce the
performance of other FortiGate systems.

Toggling Disk Usage for logging or wan-opt
Both logging and WAN Optimization use hard disk space to save data. In FortiOS, you cannot use the same hard
disk for WAN Optimization and logging.

l If the FortiGate has one hard disk, then it can be used for either disk logging or WAN optimization, but not both. By
default, the hard disk is used for disk logging.

l If the FortiGate has two hard disks, then one disk is always used for disk logging and the other disk is always used
for WAN optimization.

On the FortiGate, go to System > Advanced > Disk Settings to switch between Local Log andWAN
Optimization.

You can also change disk usage from the CLI using the following command:

configure system global
set disk-usage {log | wanopt}

end

The Toggle Disk Usage feature is supported on all new "E" Series models, while
support for "D" Series models may vary.

Please refer to the Feature Platform Matrix for more information.

Changing the disk setting formats the disk, erases current data stored on the disk and
disables either disk logging or WAN Optimization.

You can configure WAN Optimization from the CLI or the GUI. To configure WAN Optimization from the GUI you
must go to System > Feature Visibility and turn on WAN Optimization.

Remote logging (including logging to FortiAnalyzer and remote Syslog servers) is not
affected by using the single local hard disk for WAN Optimization.

Enabling WAN Optimization affects more than just disk logging

In addition to affecting WAN Optimization, the following table shows other features affected by the FortiGate disk
configuration.
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Features affected by Disk Usage as per the number of internal hard disks on the FortiGate

Feature Logging Only
(1 hard disk)

WAN Opt. Only
(1 hard disk)

Logging & WAN Opt.
(2 hard disks)

Logging Supported Not supported Supported

Report/Historical
FortiView

Supported Not supported Supported

Firewall Packet
Capture (Policy
Capture and
Interface Capture)

Supported Not supported Supported

AV Quarantine Supported Not supported Supported

IPS Packet
Capture

Supported. Not supported Supported

DLP Archive Supported Not supported Supported

Sandbox
DB & Results

FortiSandbox database and results are also stored on disk, but will not be affected by
this feature.

Example topologies relevant to WAN Optimization

FortiGate WAN optimization consists of a number of techniques that you can apply to improve the efficiency of
communication across your WAN. These techniques include protocol optimization, byte caching, web caching,
SSL offloading, and secure tunneling. Protocol optimization can improve the efficiency of traffic that uses the
CIFS, FTP, HTTP, or MAPI protocol, as well as general TCP traffic. Byte caching caches files and other data on
FortiGate units to reduce the amount of data transmitted across the WAN. Web caching stores web pages on
FortiGate units to reduce latency and delays between the WAN and web servers. SSL offloading offloads SSL
decryption and encryption from web servers onto FortiGate SSL acceleration hardware. Secure tunneling secures
traffic as it crosses the WAN.

You can apply different combinations of these WAN optimization techniques to a single traffic stream depending
on the traffic type. For example, you can apply byte caching and secure tunneling to any TCP traffic. For HTTP
and HTTPS traffic, you can also apply protocol optimization and web caching.

You can configure a FortiGate unit to be an explicit web proxy server for both IPv4 and IPv6 traffic and an explicit
FTP proxy server. Users on your internal network can browse the Internet through the explicit web proxy server or
connect to FTP servers through the explicit FTP proxy server. You can also configure these proxies to protect
access to web or FTP servers behind the FortiGate unit using a reverse proxy configuration.

Web caching can be applied to any HTTP or HTTPS traffic, this includes normal traffic accepted by a security
policy, explicit web proxy traffic, and WAN optimization traffic.

You can also configure a FortiGate unit to operate as a Web Cache Communication Protocol (WCCP) client or
server. WCCP provides the ability to offload web caching to one or more redundant web caching servers.
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FortiGate units can also apply security profiles to traffic as part of a WAN optimization, explicit web proxy, explicit
FTP proxy, web cache and WCCP configuration. Security policies that include any of these options can also
include settings to apply all forms of security profiles supported by your FortiGate unit.

Basic WAN optimization topology
The basic FortiGate WAN optimization topology consists of two FortiGate units operating asWAN optimization
peers intercepting and optimizing traffic crossing the WAN between the private networks.

Security device and WAN optimization topology

FortiGate units can be deployed as security devices that protect private networks connected to the WAN and also
perform WAN optimization. In this configuration, the FortiGate units are configured as typical security devices for
the private networks and are also configured for WAN optimization. The WAN optimization configuration
intercepts traffic to be optimized as it passes through the FortiGate unit and uses a WAN optimization tunnel with
another FortiGate unit to optimize the traffic that crosses the WAN.

You can also deployWAN optimization on single-purpose FortiGate units that only perform WAN optimization. In
the out of path WAN optimization topology shown below, FortiGate units are located on the WAN outside of the
private networks. You can also install the WAN optimization FortiGate units behind the security devices on the
private networks.

The WAN optimization configuration is the same for FortiGate units deployed as security devices and for single-
purpose WAN optimization FortiGate units. The only differences would result from the different network
topologies.

Out-of-path WAN Optimization topology
In an out-of-path topology, one or both of the FortiGate units configured for WAN optimization are not directly in
the main data path. Instead, the out-of-path FortiGate unit is connected to a device on the data path, and the
device is configured to redirect sessions to be optimized to the out-of-path FortiGate unit.

Single-purpose WAN optimization topology

The following out-of-path FortiGate units are configured for WAN optimization and connected directly to
FortiGate units in the data path. The FortiGate units in the data path use a method such as policy routing to
redirect traffic to be optimized to the out-of-path FortiGate units. The out-of-path FortiGate units establish a
WAN optimization tunnel between each other and optimize the redirected traffic.

Out-of-path WAN optimization

One of the benefits of out-of-path WAN optimization is that out-of-path FortiGate units only perform WAN
optimization and do not have to process other traffic. An in-path FortiGate unit configured for WAN optimization
also has to process other non-optimized traffic on the data path.

The out-of-path FortiGate units can operate in NAT or Transparent mode.
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Other out-of-path topologies are also possible. For example, you can install the out-of-path FortiGate units on the
private networks instead of on the WAN. Also, the out-of-path FortiGate units can have one connection to the
network instead of two. In a one-arm configuration such as this, security policies and routing have to be
configured to send the WAN optimization tunnel out the same interface as the one that received the traffic.

Topology for multiple networks
As shown in below, you can create multiple WAN optimization configurations between many private networks.
Whenever WAN optimization occurs, it is always between two FortiGate units, but you can configure any
FortiGate unit to perform WAN optimization with any of the other FortiGate units that are part of your WAN.

WAN optimization among multiple networks

You can also configure WAN optimization between FortiGate units with different roles on the WAN. FortiGate
units configured as security devices and for WAN optimization can perform WAN optimization as if they are
single-purpose FortiGate units just configured for WAN optimization.

WAN optimization with web caching
You can add web caching to a WAN optimization topology when users on a private network communicate with
web servers located across the WAN on another private network.

WAN optimization with web caching topology

The topology above is the same as that shown in WAN optimization with web caching on page 1114 with the
addition of web caching to the FortiGate unit in front of the private network that includes the web servers. You can
also add web caching to the FortiGate unit that is protecting the private network. In a similar way, you can add
web caching to anyWAN Optimization topology.

Explicit Web proxy topologies
You can configure a FortiGate unit to be an explicit web proxy server for Internet web browsing of IPv4 and IPv6
web traffic. To use the explicit web proxy, users must add the IP address of the FortiGate interface configured for
the explicit web proxy to their web browser proxy configuration.

Explicit web proxy topology

If the FortiGate unit supports web caching, you can also add web caching to the security policy that accepts
explicit web proxy sessions The FortiGate unit then caches Internet web pages on a hard disk to improve web
browsing performance.

Explicit web proxy with web caching topology
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Explicit FTP proxy topologies
You can configure a FortiGate unit to be an explicit FTP proxy server for FTP users. To use the explicit web proxy,
FTP users must connect to and authenticate with the explicit FTP proxy before connecting to an FTP server.

Explicit FTP proxy topology

You can also configure reverse explicit FTP proxy. In this configuration, users on the Internet connect to the
explicit web proxy before connecting to an FTP server installed behind a FortiGate unit.

Reverse explicit FTP proxy topology

Web caching topologies
FortiGate web caching can be added to any security policy and any HTTP or HTTPS traffic accepted by that
security policy can be cached on the FortiGate unit hard disk. This includesWAN optimization and explicit web
proxy traffic. The network topologies for these scenarios are very similar. They involved a FortiGate unit installed
between users and web servers with web caching enabled.

A typical web-caching topology includes one FortiGate unit that acts as a web cache server. Web caching is
enabled in a security policy and the FortiGate unit intercepts web page requests accepted by the security policy,
requests web pages from the web servers, caches the web page contents, and returns the web page contents to
the users. When the FortiGate unit intercepts subsequent requests for cached web pages, the FortiGate unit
contacts the destination web server just to check for changes.

Web caching topology

You can also configure reverse proxy web-caching. In this configuration, users on the Internet browse to a web
server installed behind a FortiGate unit. The FortiGate unit intercepts the web traffic (HTTP and HTTPS) and
caches pages from the web server. Reverse proxy web caching on the FortiGate unit reduces the number of
requests that the web server must handle, leaving it free to process new requests that it has not serviced before.

Reverse proxy web caching topology

WCCP topologies
You can operate a FortiGate unit as a Web Cache Communication Protocol (WCCP) router or cache engine. As a
router, the FortiGate unit intercepts web browsing requests from client web browsers and forwards them to a
WCCP cache engine. The cache engine returns the required cached content to the client web browser. If the
cache server does not have the required content it accesses the content, caches it and returns the content to the
client web browser.
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WCCP topology

FortiGate units can also operate asWCCP cache servers, communicating with WCCP routers, caching web
content and providing it to client web browsers as required.

WCCP is transparent to client web browsers. The web browsers do not have to be configured to use a web proxy.

Inside FortiOS: WAN Optimization

Enterprises deploying FortiOS can leverage WAN optimization to provide fast and secure application responses
between locations on a Wide Area Network (WAN). The web caching component of FortiOSWAN optimization
extends this protection and performance boost to cloud services.

Centralize without compromising your WAN performance
Many multi-location enterprise environments reduce costs and consolidate resources by centralizing applications
or providing applications in the cloud. Efficient and high-speed communication between applications and their
users is critical. Remote sites don’t always have access to high bandwidth, but users at all sites expect consistent
network performance. Minimizing user impact and improving performance is especially vital when applications
designed for local area networks (LANs) are on the cloud.

Even applications that work fine on a local LAN, such asWindows File Sharing (CIFS), email exchange (MAPI),
and many others, suffer from bandwidth limitations and latency issues when accessed over a WAN. This results
in a loss of productivity and a perceived need for expensive network upgrades. FortiOS’sWAN Optimization
provides an inexpensive and easy way to deploy a solution to this problem.

FortiOS is commonly deployed in central offices, satellite offices, and in the cloud to provide secure
communications across a WAN using IPsec or SSL VPN. This installed infrastructure can be leveraged to add
more value by using WAN Optimization to accelerate WAN traffic and web caching to accelerate could services.

FortiOS WAN Optimization
FortiOS includes license-free WAN Optimization on most current FortiGate devices. WAN Optimization is a
comprehensive solution that maximizes your WAN performance and provides intelligent bandwith management
and unmatched consolidated security performance. WAN Optimization reduces your network overhead and
removes unneccessary traffic for a better overall performance experience. Efficient use of bandwidth and better
application performance will remove the need for costly WAN link upgrades between data centers and other
expensive solutions for your network traffic growth.

Protocol optimization
Protocol optimization is effective for applications designed for the LAN that do not function well on low bandwidth
high latency networks. FortiOS protocol optimization improves the efficiency of CIFS, FTP, HTTP, MAPI, and
general TCP sessions.
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For example, CIFS, which is a fairly “chatty” protocol, requires many background transactions to successfully
transfer a single file. When transferring the file, CIFS sends small chunks of data and waits sequentially for each
chunk’s arrival and acknowledgment before sending the next. This large amount of request/acknowledgement
traffic can delay transfers. FortiOS CIFSWAN Optimization removes this chatiness and gets on with the job of
transferring the file.

TCP protocol optimization uses techniques such as SACK support, window scaling and window size adjustment,
and connection pooling to remove commonWAN TCP bottlenecks.

Web caching
In an enterprise environment, multiple users will often want to get the same content (for example, a sales
spreadsheet, a corporate presentation or a PDF from a cloud service, or a software update). With FortiOSWeb
caching, content from the cloud, from the web or from other sites on the WAN is download once and cached on
the local FortiGate device. When other uses access the same content they download it from the cache. The result
is less bandwidth use and reduced latency for the file requester.

FortiOS web caching also recognizes requests for Windows or MS-Office updates and downloads the new update
file in the background. Once downloaded to the cache, the new update file is available to all users and all
subsequent requests for this update are rapidly downloaded from the cache.

Byte caching
Byte caching improves caching by accelerating the transfer of similar, but not identical content. Byte caching
accelerates multiple downloads of different email messages with the same corporate disclaimer by downloading
the disclaimer over the WAN once and then downloading all subsequent disclaimers from a local FortiGate unit.
Byte caching reduces the amount of data crossing the WAN when multiple different emails with the same or
similar attachments or different versions of an attachment are downloaded from a corporate email server to
different locations over the WAN.
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Dynamic data chunking

Dynamic data chunking detects and optimizes persistent data chunks in changed files or in data embedded in
traffic that uses an unknown protocol. For example, dynamic chunking can cache data in Lotus notes traffic and
make the data chunks available for email and other protocols.

Data Deduplication

Byte caching breaks large units of application data, like an email attachment or a file download, into manageable
small chunks of data. Each chunk of data is labeled with a hash, and chunks with their respective hashes are
stored in a database on the local FortiGate unit. When a remote user request a file, the WAN Optimization sends
the hashes, rather than the actual data. The FortiGate unit at the other end of the WAN tunnel reassembles the
data from its own hash database, only downloading chunks that it is missing. Deduplication, or the process of
eliminating duplicate data, will reduce space consumption. In addition to reducing the amount of data
downloaded across the WAN, byte caching is not application specific and assists by accelerating all of the
protocols supported byWAN Optimization.

Server Monitoring and Management
The health and performance of real servers can be monitored from the FortiGate GUI. Virtual servers and their
assigned real servers can be monitored for health status, if there have been any monitor events, number of active
sessions, round trip time and number of bytes processed. Should a server become problematic and require
administration, it can be gracefully removed from the Real Server pool to enable disruption free maintenance.
When a removed real server is able to operate it can gracefully be added back to the virtual server.

SSL acceleration
SSL is used by many organizations to keep WAN communications private. WAN Optimization boosts SSL
acceleration properties of FortiGate FortiASIC hardware by accelerating SSL traffic across the WAN. The
FortiGate unit handles SSL encryption/decryption for corporate servers providing SSL encrypted connections over
the WAN.

VPN replacement
FortiOSWAN optimization supports secure SSL-encrypted tunnels between FortiGate units on the WAN.
Employing secure WAN Optimization tunnels can replace IPsec VPNs between sites. The result is a single,
relatively simple configuration that supports optimization and privacy of communication across the WAN and uses
FortiGate SSL acceleration to provide high performance.

Road warriors and home workers
The drive to give employees greater flexibility and reduce operational costs has led to more remote workers, both
at home and on the road. Whether accessing the office from a hotel, public wireless hotspot, or home, the
problem is the same: low bandwidth and high latency harming application performance. WAN Optimization is
integrated into FortiClient, which can be installed on PCs and wireless devices to optimize communication
between remote workers and their offices.
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Reduce your...

l Capital outlay:Organizations only need to purchase a single device per location.
l Licensing costs:WANOptimization is included with FortiOS. Additional licenses are not needed.
l Network complexity: Small offices that may not have the space or power connections for multiple devices do not

need to worry: no additional devices are required.

WAN Optimization Concepts

Client/server architecture
Traffic across a WAN typically consists of clients on a client network communicating across a WAN with a remote
server network. The clients do this by starting communication sessions from the client network to the server
network. These communication sessions can be open text over the WAN or they can be encrypted by SSL VPN or
IPsec VPN.

To optimize these sessions, you can addWAN optimization security policies to the client-side FortiGate
unit to accept sessions from the client network that are destined for the server network. The client-side FortiGate
unit is located between the client network and the WAN. WAN optimization security policies includeWAN
optimization profiles that control how the traffic is optimized.

The client-side FortiGate unit must also include the IP address of the server-side FortiGate unit in its WAN
optimization peer configuration. The server-side FortiGate unit is located between the server network and the
WAN, The peer configuration allows the client-side FortiGate unit to find the server-side FortiGate unit and
attempt to establish a WAN optimization tunnel with it.

For the server-side FortiGate unit you must add a security policy withwanopt as the Incoming Interface. This
security policy allows the FortiGate unit to accept WAN optimization sessions from the client-side FortiGate unit.
For the server-side FortiGate unit to accept a WAN optimization connection it must have the client-side FortiGate
unit in its WAN optimization peer configuration.

WAN optimization profiles are only added to the client-side WAN optimization security
policy. The server-side FortiGate unit employs the WAN optimization settings set in
the WAN optimization profile on the client-side FortiGate unit.

Client/server architecture

When both peers are identified the FortiGate units attempt to establish a WAN optimization tunnel between
them. WAN optimization tunnels use port 7810. All optimized data flowing across the WAN between the client-
side and server-side FortiGate units use this tunnel. WAN optimization tunnels can be encrypted use SSL
encryption to keep the data in the tunnel secure.

Any traffic can be sent through a WAN optimization tunnel. This includes SSL and IPsec VPN traffic. However,
instead of configuring SSL or IPsec VPN for this communication you can add SSL encryption using the WAN
optimization tunnel.

In addition to basic identification by peer host ID and IP address you can configure WAN optimization
authentication using certificates and pre-shared keys to improve security. You can also configure FortiGate units

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1119



WANOptimization Concepts Chapter 9 - Firewall

involved in WAN optimization to accept connections from any identified peer or restrict connections to specific
peers.

The FortiClient application can act in the same manner as a client-side FortiGate unit to optimize traffic between
a computer running FortiClient and a FortiGate unit.

WAN optimization peers
The client-side and server-side FortiGate units are called WAN optimization peers because all of the FortiGate
units in a WAN optimization network have the same peer relationship with each other. The client and server roles
just relate to how a session is started. Any FortiGate unit configured for WAN optimization can be a client-side
and a server-side FortiGate unit at the same time, depending on the direction of the traffic. Client-side FortiGate
units initiate WAN optimization sessions and server-side FortiGate units respond to the session requests. Any
FortiGate unit can simultaneously be a client-side FortiGate unit for some sessions and a server-side FortiGate
unit for others.

WAN optimization peer and tunnel architecture

To identify all of the WAN optimization peers that a FortiGate unit can perform WAN optimization with, you add
host IDs and IP addresses of all of the peers to the FortiGate unit configuration. The peer IP address is actually
the IP address of the peer unit interface that communicates with the FortiGate unit.

Protocol optimization
Protocol optimization techniques optimize bandwidth use across the WAN. These techniques can improve the
efficiency of communication across the WAN optimization tunnel by reducing the amount of traffic required by
communication protocols. You can apply protocol optimization to Common Internet File System (CIFS), FTP,
HTTP, MAPI, and general TCP sessions. You can apply general TCP optimization to MAPI sessions.

For example, CIFS provides file access, record locking, read/write privileges, change notification, server name
resolution, request batching, and server authentication. CIFS is a fairly “chatty” protocol, requiring many
background transactions to successfully transfer a single file. This is usually not a problem across a LAN.
However, across a WAN, latency and bandwidth reduction can slow down CIFS performance.

When you select the CIFS protocol in a WAN optimization profile, the FortiGate units at both ends of the WAN
optimization tunnel use a number of techniques to reduce the number of background transactions that occur over
the WAN for CIFS traffic.

If a policy accepts a range of different types of traffic, you can set Protocol to TCP to apply general optimization
techniques to TCP traffic. However, applying this TCP optimization is not as effective as applying more protocol-
specific optimization to specific types of traffic. TCP protocol optimization uses techniques such as TCP SACK
support, TCPwindow scaling and window size adjustment, and TCP connection pooling to remove TCP
bottlenecks.

Protocol optimization and MAPI
By default the MAPI service uses port number 135 for RPC port mapping and may use random ports for MAPI
messages. The random ports are negotiated through sessions using port 135. The FortiOS DCE-RPC session
helper learns these ports and opens pinholes for the messages. WAN optimization is also aware of these ports
and attempts to apply protocol optimization to MAPI messages that use them. However, to configure protocol
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optimization for MAPI you should set the WAN optimization profile to a single port number (usually port 135).
Specifying a range of ports may reduce performance.

Byte caching
Byte caching breaks large units of application data (for example, a file being downloaded from a web page) into
small chunks of data, labeling each chunk of data with a hash of the chunk and storing those chunks and their
hashes in a database. The database is stored on a WAN optimization storage device. Then, instead of sending
the actual data over the WAN tunnel, the FortiGate unit sends the hashes. The FortiGate unit at the other end of
the tunnel receives the hashes and compares them with the hashes in its local byte caching database. If any
hashes match, that data does not have to be transmitted over the WAN optimization tunnel. The data for any
hashes that does not match is transferred over the tunnel and added to that byte caching database. Then the unit
of application data (the file being downloaded) is reassembled and sent to its destination.

The stored byte caches are not application specific. Byte caches from a file in an email can be used to optimize
downloading that same file or a similar file from a web page.

The result is less data transmitted over the WAN. Initially, byte caching may reduce performance until a large
enough byte caching database is built up.

To enable byte caching, you select Byte Caching in a WAN optimization profile.

Byte caching cannot determine whether or not a file is compressed (for example a zip file), and caches
compressed and non-compressed versions of the same file separately.

Dynamic data chunking for byte caching

Dynamic data chunking can improve byte caching by improving detection of data chunks that are already cached
in changed files or in data embedded in traffic using an unknown protocol. Dynamic data chunking is available for
HTTP, CIFS and FTP.

Use the following command to enable dynamic data chunking for HTTP in the default WAN optimization profile.

config wanopt profile
edit default

config http
set prefer-chunking dynamic

end

By default dynamic data chunking is disabled and prefer-chunking is set to fix.

WAN optimization transparent mode
WAN optimization is transparent to users. This means that with WAN optimization in place, clients connect to
servers in the same way as they would without WAN optimization. However, servers receiving packets after WAN
optimization “see” different source addresses depending on whether or not transparent mode is selected for WAN
optimization. If transparent mode is selected, WAN optimization keeps the original source address of the
packets, so servers appear to receive traffic directly from clients. Routing on the server network should be
configured to route traffic with client source IP addresses from the server-side FortiGate unit to the server and
back to the server-side FortiGate unit.
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Some protocols, for example CIFS, may not function as expected if transparent mode
is not selected. In most cases, for CIFSWAN optimization you should select
transparent mode and make sure the server network can route traffic as described to
support transparent mode.

If transparent mode is not selected, the source address of the packets received by servers is changed to the
address of the server-side FortiGate unit interface that sends the packets to the servers. So servers appear to
receive packets from the server-side FortiGate unit. Routing on the server network is simpler in this case because
client addresses are not involved. All traffic appears to come from the server-side FortiGate unit and not from
individual clients.

Do not confuse WAN optimization transparent mode with FortiGate transparent mode.
WAN optimization transparent mode is similar to source NAT. FortiGate Transparent
mode is a system setting that controls how the FortiGate unit (or a VDOM) processes
traffic.

Configuring Transparent mode

You can configure transparent mode by selecting Transparent in a WAN Optimization profile. The profile is
added to an active WAN Optimization policy.

When you configure a passive WAN Optimization policy you can accept the active policy transparent setting or
you can override the active policy transparent setting. From the GUI you can do this by setting the Passive
Option as follows:

l default use the transparent setting in the WAN Optimization profile added to the active policy (client-side
configuration).

l transparent impose transparent mode (override the active policy transparent mode setting). Packets exiting the
FortiGate keep their original source addresses.

l non-transparent impose non-transparent mode (override the active policy transparent mode setting). Packets
exiting the FortiGate have their source address changed to the address of the server-side FortiGate unit interface
that sends the packets to the servers.

From the CLI you can use the following command:

config firewall policy
set wanopt-passive-opt {default | transparent | non-transparent}

end

Operating modes and VDOMs
To use WAN optimization, the FortiGate units can operate in either NAT or Transparent mode. The client-side
and server-side FortiGate units do not have to be operating in the same mode.

As well, the FortiGate units can be configured for multiple virtual domain (VDOM) operation. You configure WAN
optimization for each VDOM and configure one or both of the units to operate with multiple VDOMs enabled.

If a FortiGate unit or VDOM is operating in Transparent mode with WAN optimization enabled, WAN optimization
uses the management IP address as the peer IP address of the FortiGate unit instead of the address of an
interface.
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WAN optimization tunnels
All optimized traffic passes between the FortiGate units over a WAN optimization tunnel. Traffic in the tunnel can
be sent in plain text or encrypted using AES-128bit-CBC SSL.

WAN optimization tunnels

Both plain text and the encrypted tunnels use TCP destination port 7810.

Before a tunnel can be started, the peers must be configured to authenticate with each other. Then, the client-
side peer attempts to start a WAN optimization tunnel with the server-side peer. Once the peers authenticate with
each other, they bring up the tunnel and WAN optimization communication over the tunnel starts. After a tunnel
has been established, multiple WAN optimization sessions can start and stop between peers without restarting
the tunnel.

Tunnel sharing

You can use the tunnel-sharingWAN optimization profile CLI keyword to configure tunnel sharing for WAN
optimization rules. Tunnel sharing means multiple WAN optimization sessions share the same tunnel. Tunnel
sharing can improve performance by reducing the number of WAN optimization tunnels between FortiGate units.
Having fewer tunnels means less data to manage. Also, tunnel setup requires more than one exchange of
information between the ends of the tunnel. Once the tunnel is set up, each new session that shares the tunnel
avoids tunnel setup delays.

Tunnel sharing also uses bandwidth more efficiently by reducing the chances that small packets will be sent down
the tunnel. Processing small packets reduces network throughput, so reducing the number of small packets
improves performance. A shared tunnel can combine all the data from the sessions being processed by the tunnel
and send the data together. For example, suppose a FortiGate unit is processing five WAN optimization sessions
and each session has 100 bytes to send. If these sessions use a shared tunnel, WAN optimization combines the
packets from all five sessions into one 500-byte packet. If each session uses its own private tunnel, five 100-byte
packets will be sent instead. Each packet also requires a TCP ACK reply. The combined packet in the shared
tunnel requires one TCP ACK packet. The separate packets in the private tunnels require five.

Use the following command to configure tunnel sharing for HTTP traffic in a WAN optimization profile.

config wanopt profile
edit default

config http
set tunnel-sharing {express-shared | private | shared}

end

Tunnel sharing is not always recommended and may not always be the best practice. Aggressive and non-
aggressive protocols should not share the same tunnel. An aggressive protocol can be defined as a protocol that
is able to get more bandwidth than a non-aggressive protocol. (The aggressive protocols can “starve” the non-
aggressive protocols.) HTTP and FTP are considered aggressive protocols. If aggressive and non-aggressive
protocols share the same tunnel, the aggressive protocols may take all of the available bandwidth. As a result,
the performance of less aggressive protocols could be reduced. To avoid this problem, rules for HTTP and FTP
traffic should have their own tunnel. To do this, set tunnel-sharing to private for WAN optimization rules
that accept HTTP or FTP traffic.
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It is also useful to set tunnel-sharing to express-shared for applications, such as Telnet, that are very
interactive but not aggressive. Express sharing optimizes tunnel sharing for Telnet and other interactive
applications where latency or delays would seriously affect the user’s experience with the protocol.

Set tunnel-sharing to shared for applications that are not aggressive and are not sensitive to latency or
delays. WAN optimization rules set to sharing and express-shared can share the same tunnel.

WAN optimization and user and device identity policies, load balancing and traffic shaping
Please note the following about WAN optimization and firewall policies:

l WAN optimization is not compatible with firewall load balancing.
l WAN optimization is compatible with source and destination NAT options in firewall policies (including firewall

virtual IPs). If a virtual IP is added to a policy the traffic that exits the WAN optimization tunnel has its destination
address changed to the virtual IPs mapped to IP address and port.

l WAN optimization is compatible with user identity-based and device identity security policies. If a session is allowed
after authentication or device identification the session can be optimized.

Traffic shaping

Traffic shaping works for WAN optimization traffic that is not in a WAN optimization tunnel. So traffic accepted by
a WAN optimization security policy on a client-side FortiGate unit can be shaped on ingress. However, when the
traffic enters the WAN optimization tunnel, traffic shaping is not applied.

In manual mode:

l Traffic shaping works as expected on the client-side FortiGate unit.
l Traffic shaping cannot be applied to traffic on the server-side FortiGate unit.

In active-passive mode:

l Traffic shaping works as expected on the client-side FortiGate unit.
l If transparent mode is enabled in the WAN optimization profile, traffic shaping also works as expected on the

server-side FortiGate unit.
l If transparent mode is not enabled, traffic shaping works partially on the server-side FortiGate unit.

WAN optimization and HA
You can configure WAN optimization on a FortiGate HA cluster. The recommended best practice HA
configuration for WAN optimization is active-passive mode. When the cluster is operating, all WAN optimization
sessions are processed by the primary unit only. Even if the cluster is operating in active-active mode, HA does
not load-balance WAN optimization sessions.

You can also form a WAN optimization tunnel between a cluster and a standalone FortiGate unit or between two
clusters.

In a cluster, only the primary unit stores the byte cache database. This database is not synchronized to the
subordinate units. So, after a failover, the new primary unit must rebuild its byte cache. Rebuilding the byte cache
can happen relatively quickly because the new primary unit gets byte cache data from the other FortiGate unit
that it is participating with in WAN optimization tunnels.
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WAN optimization, web caching and memory usage
To accelerate and optimize disk access and to provide better throughput and less latency FortiOSWAN
optimization uses provisioned memory to reduce disk I/O and increase disk I/O efficiency. In addition, WAN
optimization requires a small amount of additional memory per session for comprehensive flow control logic and
efficient traffic forwarding.

When WAN optimization is enabled you will see a reduction in available memory. The reduction increases when
more WAN optimization sessions are being processed. If you are thinking of enabling WAN optimization on an
operating FortiGate unit, make sure its memory usage is not maxed out during high traffic periods.

In addition to using the system dashboard to see the current memory usage you can use the get test wad 2
command to see how much memory is currently being used byWAN optimization. See "get test {wad | wccpd}
<test_level>" for more information.

WAN Optimization Configuration

This chapter describes FortiGate WAN optimization client server architecture and other concepts you need to
understand to be able to configure FortiGate WAN optimization.

Manual (peer-to-peer) and active-passive WAN optimization
You can createmanual (peer-to-peer) and active-passiveWAN optimization configurations.

In reality, because WAN optimization traffic can only be processed by one CPU core, it
is not recommended to increase the number of manual mode peers on the FortiGate
unit per VDOM.

Note that the maximum number of manual peers are restricted to 256 per VDOM.
However, in Active-Passive configurations, there is no hard-limit to the maximum
number of manual peers per VDOM.

Manual (peer to peer) configurations

Manual configurations allow for WAN optimization between one client-side FortiGate unit and one server-side
FortiGate unit. To create a manual configuration you add amanual modeWAN optimization security policy to
the client-side FortiGate unit. The manual mode policy includes the peer ID of a server-side FortiGate unit.

In a manual mode configuration, the client-side peer can only connect to the named server-side peer. When the
client-side peer initiates a tunnel with the server-side peer, the packets that initiate the tunnel include extra
information so that the server-side peer can determine that it is a peer-to-peer tunnel request. This extra
information is required because the server-side peer does not require a WAN optimization policy; however, you
need to add the client peer host ID and IP address to the server-side FortiGate unit peer list.

In addition, from the server-side FortiGate unit CLI you must and an Explicit Proxy security policy with proxy set
to wanopt and the destination interface and network set to the network containing the servers that clients
connect to over the WAN optimization tunnel. WAN optimization tunnel requests are accepted by the explicit
proxy policy and if the client-side peer is in the server side peer’s address list the traffic is forwarded to the servers
on the destination network.
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Manual mode client-side policy

You must configure manual mode client-side policies from the CLI. From the GUI a manual mode policy has
WAN Optimization turned on and includes the following text beside theWAN optimization field: Manual (Profile:
<profile-name>. Peer: <peer-name>.

Add a manual mode policy to the client-side FortiGate unit from the CLI. The policy enablesWAN optimization,
sets wanopt-detection to off, and uses the wanopt-peer option to specify the server-side peer. The
following example uses the default WAN optimization profile.

config firewall policy
edit 2

set srcintf internal
set dstintf wan1
set srcaddr client-subnet
set dstaddr server-subnet
set action accept
set schedule always
set service ALL
set wanopt enable
set wanopt-detection off
set wanopt-profile default
set wanopt-peer server

next
end

Manual mode server-side explicit proxy policy

The server-side explicit proxy policy allows connections from the WAN optimization tunnel to the server network
by setting the proxy type to wanopt. You must add policies that set proxy to wanopt from the CLI and these
policies do not appear on the GUI. The policy should look like the following:

configure firewall proxy-policy
edit 3

set proxy wanopt
set dstintf internal
set srcaddr all
set dstaddr server-subnet
set action accept
set schedule always
set service ALL

next
end

Active-passive configurations

Active-passive WAN optimization requires an activeWAN optimization policy on the client-side FortiGate unit
and a passiveWAN optimization policy on the server-side FortiGate unit. The server-side FortiGate unit also
requires an explicit proxy policy with proxy set to wanopt.

You can use the passive policy to control WAN optimization address translation by specifying transparent mode
or non-transparent mode. SeeManual (peer-to-peer) and active-passive WAN optimization on page 1125. You
can also use the passive policy to apply security profiles, web caching, and other FortiGate features at the server-
side FortiGate unit. For example, if a server-side FortiGate unit is protecting a web server, the passive policy
could enable web caching.
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A single passive policy can accept tunnel requests from multiple FortiGate units as long as the server-side
FortiGate unit includes their peer IDs and all of the client-side FortiGate units include the server-side peer ID.

Active client-side policy

Add an active policy to the client-side FortiGate unit by turning onWAN Optimization and selecting active.
Then select a WAN optimization Profile. From the CLI the policy could look like the following:

config firewall policy
edit 2

set srcintf internal
set dstintf wan1
set srcaddr client-subnet
set dstaddr server-subnet
set action accept
set schedule always
set service ALL
set wanopt enable
set wanopt-detection active
set wanopt-profile default

next
end

Server-side tunnel policy

The server-side requires an explicit proxy policy that sets the proxy to wanopt. You must add this policy from
the CLI and policies with proxy set to wanopt do not appear on the GUI. From the CLI the policy could look like
the following:

configure firewall proxy-policy
edit 3

set proxy wanopt
set dstintf internal
set srcaddr all
set dstaddr server-subnet
set action accept
set schedule always
set service ALL

next
end

Server-side passive policy

Add a passive policy to the server-side FortiGate unit by selecting Enable WAN Optimization and selecting
passive. Then set the Passive Option to transparent. From the CLI the policy could look like the following:

config firewall policy
edit 2

set srcintf "wan1"
set dstintf "internal"
set srcaddr "all"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"
set wanopt enable
set wanopt-detection passive
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set wanopt-passive-opt transparent
next

WAN optimization profiles
Use WAN optimization profiles to apply WAN optimization techniques to traffic to be optimized. In a WAN
optimization profile you can select the protocols to be optimized and for each protocol you can enable SSL
offloading (if supported), secure tunneling, byte caching and set the port or port range the protocol uses. You can
also enable transparent mode and optionally select an authentication group. You can edit the default WAN
optimization profile or create new ones.

To configure a WAN optimization profile go toWAN Opt. & Cache > Profiles and edit a profile or create a new
one.

Configuring a WAN optimization profile

From the CLI you can use the following command to configure a WAN optimization profile to optimize HTTP
traffic.

config wanopt profile
edit new-profile

config http
set status enable

end

Transparent Mode Servers receiving packets after WAN optimization “see” different source
addresses depending on whether or not you select Transparent Mode.

For more information, see WAN optimization profiles on page 1128.

Authentication Group

Select this option and select an authentication group so that the client and
server-side FortiGate units must authenticate with each other before
starting the WAN optimization tunnel. You must also select an
authentication group if you select Secure Tunneling for any protocol.

You must add identical authentication groups to both of the FortiGate units
that will participate in the WAN optimization tunnel. For more information,
see .

Protocol Select CIFS, FTP, HTTP or MAPI to apply protocol optimization for the
selected protocols. See WAN optimization profiles on page 1128.

Select TCP if the WAN optimization tunnel accepts sessions that use more
than one protocol or that do not use the CIFS, FTP, HTTP, or MAPI
protocol.
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SSL Offloading

Select to apply SSL offloading for HTTPS or other SSL traffic. You can use
SSL offloading to offload SSL encryption and decryption from one or more
HTTP servers to the FortiGate unit. If you enable this option, you must
configure the security policy to accept SSL-encrypted traffic.

If you enable SSL offloading, you must also use the CLI command
config firewall ssl-server to add an SSL server for each HTTP
server that you want to offload SSL encryption/decryption for. For more
information, see .

Secure
Tunnelling

The WAN optimization tunnel is encrypted using SSL encryption. You must
also add an authentication group to the profile. For more information, see .

Byte Caching Select to apply WAN optimization byte caching to the sessions accepted by
this rule. For more information, see “Byte caching”.

Port Enter a single port number or port number range. Only packets whose
destination port number matches this port number or port number range
will be optimized.

Processing non-HTTP sessions accepted by a WAN optimization profile with HTTP
optimization

From the CLI, you can use the following command to configure how to process non-HTTP sessions when a rule
configured to accept and optimize HTTP traffic accepts a non-HTTP session. This can occur if an application
sends non-HTTP sessions using an HTTP destination port.

config wanopt profile
edit default

config http
set status enable
set tunnel-non-http {disable | enable}

end

To drop non-HTTP sessions accepted by the rule set tunnel-non-http to disable, or set it to enable to
pass non-HTTP sessions through the tunnel without applying protocol optimization, byte-caching, or web
caching. In this case, the FortiGate unit applies TCP protocol optimization to non-HTTP sessions.

Processing unknown HTTP sessions

Unknown HTTP sessions are HTTP sessions that do not comply with HTTP 0.9, 1.0, or 1.1. From the CLI, use
the following command to specify how a rule handles such HTTP sessions.

config wanopt profile
edit default

config http
set status enable
set unknown-http-version {best-effort | reject | tunnel}

end

To assume that all HTTP sessions accepted by the rule comply with HTTP 0.9, 1.0, or 1.1, select best-
effort. If a session uses a different HTTP version, WAN optimization may not parse it correctly. As a result, the
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FortiGate unit may stop forwarding the session and the connection may be lost. To reject HTTP sessions that do
not use HTTP 0.9, 1.0, or 1.1, select reject.

To pass HTTP sessions that do not use HTTP 0.9, 1.0, or 1.1, but without applying HTTP protocol optimization,
byte-caching, or web caching, you can also select tunnel. TCP protocol optimization is applied to these HTTP
sessions.

Monitoring WAN optimization performance
Using WAN optimization monitoring, you can confirm that a FortiGate unit is optimizing traffic and view estimates
of the amount of bandwidth saved. The WAN optimization monitor presents collected log information in a
graphical format to show network traffic summary and bandwidth optimization information.

To view the WAN optimization monitor, go toMonitor > WAN Opt. Monitor.

WAN optimization monitor

Traffic Summary

The traffic summary shows howWAN optimization is reducing the amount of traffic on the WAN for each WAN
optimization protocol by showing the traffic reduction rate as a percentage of the total traffic. The traffic summary
also shows the amount of WAN and LAN traffic. If WAN optimization is being effective the amount of WAN traffic
should be lower than the amount of LAN traffic.

You can use the refresh icon to update the traffic summary display at any time. You can also set the amount of
time for which the traffic summary shows data. The time period can vary from the last 10 minutes to the last
month.

Bandwidth Optimization

This section shows network bandwidth optimization per time period. A line or column chart compares an
application’s pre-optimized size (LAN data) with its optimized size (WAN data). You can select the chart type, the
monitoring time period, and the protocol for which to display data. If WAN optimization is being effective the
WAN bandwidth should be lower than the LAN bandwidth.

WAN optimization configuration summary
This section includes a client-side and a server-side WAN Optimization configuration summary.:

Client-side configuration summary

WAN optimization profile

Enter the following command to viewWAN optimization profile CLI options:

tree wanopt profile
-- [profile] --*name (36)

|- transparent
|- comments
|- auth-group (36)
|- <http> -- status

|- secure-tunnel
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|- byte-caching
|- prefer-chunking
|- tunnel-sharing
|- log-traffic
|- port (1,65535)
|- ssl
|- ssl-port (1,65535)
|- unknown-http-version
+- tunnel-non-http

|- <cifs> -- status
|- secure-tunnel
|- byte-caching
|- prefer-chunking
|- tunnel-sharing
|- log-traffic
+- port (1,65535)

|- <mapi> -- status
|- secure-tunnel
|- byte-caching
|- tunnel-sharing
|- log-traffic
+- port (1,65535)

|- <ftp> -- status
|- secure-tunnel
|- byte-caching
|- prefer-chunking
|- tunnel-sharing
|- log-traffic
+- port (1,65535)

+- <tcp> -- status
|- secure-tunnel
|- byte-caching
|- byte-caching-opt
|- tunnel-sharing
|- log-traffic
|- port
|- ssl
+- ssl-port (1,65535)

Local host ID and peer settings

config wanopt settings
set host-id client

end
config wanopt peer

edit server
set ip 10.10.2.82

end

Security policies

Two client-side WAN optimization security policy configurations are possible. One for active-passive WAN
optimization and one for manual WAN optimization.

Active/passive mode on the client-side

config firewall policy
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edit 2
set srcintf internal
set dstintf wan1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL
set wanopt enable <<< enable WAN optimization
set wanopt-detection active <<< set the mode to active/passive
set wanopt-profile "default" <<< select the wanopt profile

next
end

Manual mode on the client-side

config firewall policy
edit 2

set srcintf internal
set dstintf wan1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL
set wanopt enable <<< enable WAN optimization
set wanopt-detection off <<< sets the mode to manual
set wanopt-profile "default" <<< select the wanopt profile
set wanopt-peer "server" <<< set the only peer to do wanopt

                                                                    with 
(required for manual mode)

next
end

server-side configuration summary

Local host ID and peer settings

config wanopt settings
set host-id server

end
config wanopt peer

edit client
set ip 10.10.2.81

end

Security policies

Two server-side WAN optimization security policy configurations are possible. One for active-passive WAN
optimization and one for manual WAN optimization.

Active/passive mode on server-side

config firewall policy
edit 2 <<< the passive mode policy

set srcintf wan1
set dstintf internal
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set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL
set wanopt enable
set wanopt-detection passive
set wanopt-passive-opt transparent

end
config firewall proxy-policy

edit 3 <<< policy that accepts wanopt tunnel connections from the server
set proxy wanopt <<< wanopt proxy type
set dstintf internal
set srcaddr all
set dstaddr server-subnet
set action accept
set schedule always
set service ALL

next
end

Manual mode on server-side

config firewall proxy-policy
edit 3 <<< policy that accepts wanopt tunnel connections from the client

set proxy wanopt <<< wanopt proxy type
set dstintf internal
set srcaddr all
set dstaddr server-subnet
set action accept
set schedule always
set service ALL

next
end

Best practices
This is a short list of WAN optimization and explicit proxy best practices.

l WAN optimization tunnel sharing is recommended for similar types of WAN optimization traffic. However, tunnel
sharing for different types of traffic is not recommended. For example, aggressive and non-aggressive protocols
should not share the same tunnel. See Best practices on page 1133.

l Active-passive HA is the recommended HA configuration for WAN optimization. See Best practices on page 1133.
l Configure WAN optimization authentication with specific peers. Accepting any peer is not recommended as this can

be less secure. See.
l Set the explicit proxyDefault Firewall Policy Action to Deny. This means that a security policy is required to use

the explicit web proxy. See .
l Set the explicit FTP proxyDefault Firewall Policy Action to Deny. This means that a security policy is required

to use the explicit FTP proxy. See .
l Do not enable the explicit web or FTP proxy on an interface connected to the Internet. This is a security risk

because anyone on the Internet who finds the proxy could use it to hide their source address. If you must enable the
proxy on such an interface make sure authentication is required to use the proxy. See .
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Example Basic manual (peer-to-peer) WAN optimization configuration
In a manual (peer to peer) configuration the WAN optimization tunnel can be set up between one client-side
FortiGate unit and one server-side FortiGate unit. The peer ID of the server-side FortiGate unit is added to the
client-side WAN optimization policy. When the client-side FortiGate unit initiates a tunnel with the server-side
FortiGate unit, the packets that initiate the tunnel include information that allows the server-side FortiGate unit to
determine that it is a manual tunnel request. The server-side FortiGate unit does not require a WAN optimization
profile; you just need to add the client peer host ID and IP address to the server-side FortiGate unit peer list and
from the CLI an explicit proxy policy to accept WAN optimization tunnel connections.

In a manual WAN optimization configuration, you create a manual WAN optimization security policy on the client-
side FortiGate unit. To do this you must use the CLI to set wanopt-detection to off and to add the peer
host ID of the server-side FortiGate unit to the WAN optimization security policy.

Network topology and assumptions

This example configuration includes a client-side FortiGate unit called Client-Fgt with a WAN IP address of
172.20.34.12. This unit is in front of a network with IP address 172.20.120.0. The server-side FortiGate unit is
called Server_Fgt with a WAN IP address of 192.168.30.12. This unit is in front of a web server network with IP
address 192.168.10.0.

This example customizes the default WAN optimization profile on the client-side FortiGate unit and adds it to the
WAN optimization policy. You can also create a newWAN optimization profile.

Example manual (peer-to-peer) topology

General configuration steps

This section breaks down the configuration for this example into smaller procedures. For best results, follow the
procedures in the order given:

1. Configure the client-side FortiGate unit:
l Add peers.
l Configure the default WAN optimization profile to optimize HTTP traffic.
l Add a manual WAN optimization security policy.

2. Configure the server-side FortiGate unit:
l Add peers.
l Add a WAN optimization tunnel policy.

Configuring basic peer-to-peer WAN optimization - web-based manager

Use the following steps to configure the example configuration from the web-based manager.

To configure the client-side FortiGate unit

1. Go toWAN Opt. & Cache > Peersand enter a Local Host ID for the client-side FortiGate unit:

Local Host ID Client-Fgt
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2. Select Apply.
3. Select Create New and add the server-side FortiGate unit Peer Host ID and IP Address for the server-side

FortiGate:

Peer Host ID Server-Fgt

IP Address 192.168.30.12

4. Select OK.
5. Go to Policy & Objects > Addresses and select Create New to add a firewall address for the client network.

Category Address

Name Client-Net

Type Subnet

Subnet / IP Range 172.20.120.0/24

Interface port1

6. Select Create New to add a firewall address for the web server network.

Category Address

Name Web-Server-Net

Type Subnet

Subnet / IP Range 192.168.10.0/24

Interface port2

7. Go toWAN Opt. & Cache > Profiles and edit the default profile.
8. Select Transparent Mode.
9. Under Protocol, select HTTP and for HTTP select Byte Caching. Leave the HTTPPort set to 80.
10. Select Apply to save your changes.
11. Go to Policy & Objects > IPv4 Policy and add a WAN optimization security policy to the client-side FortiGate

unit that accepts traffic to be optimized:

Incoming Interface port1

Source Address all

Outgoing Interface port2

Destination Address all

Schedule always

Service ALL
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Action ACCEPT

12. Select Enable WAN Optimization and configure the following settings:

Enable WAN Optimization active

Profile default

13. Select OK.
14. Edit the policy from the CLI to turn off wanopt-detection, add the peer ID of the server-side FortiGate unit,

and the default WAN optimization profile. The following example assumes the ID of the policy is 5:
config firewall policy

edit 5
set wanopt-detection off
set wanopt-peer Server-Fgt
set wanopt-profile default

end

When you set the detection mode to off the policy becomes a manual mode WAN optimization
policy. On the web-based manager the WAN optimization part of the policy changes to the following:

Enable WAN Optimization Manual (Profile: default, Peer: Peer-Fgt-2)

To configure the server-side FortiGate unit

1. Go toWAN Opt. & Cache > Peersand enter a Local Host ID for the server-side FortiGate unit:

Local Host ID Server-Fgt

2. Select Apply.
3. Select Create New and add a Peer Host ID and the IP Address for the client-side FortiGate unit:

Peer Host ID Client-Fgt

IP Address 172.20.34.12

4. Select OK.
5. Enter the following CLI command to add an explicit proxy policy to accept WAN optimization tunnel connections.

configure firewall proxy-policy
edit 0

set proxy wanopt
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
end
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Configuring basic peer-to-peer WAN optimization - CLI

Use the following steps to configure the example WAN optimization configuration from the client-side and server-
side FortiGate unit CLI.

To configure the client-side FortiGate unit

1. Add the Local Host ID to the client-side FortiGate configuration:
config wanopt settings

set host-id Client-Fgt
end

2. Add the server-side Local Host ID to the client-side peer list:
config wanopt peer

edit Server-Fgt
set ip 192.168.30.12

end

3. Add a firewall address for the client network.
config firewall address

edit Client-Net
set type ipmask
set subnet 172.20.120.0 255.255.255.0
set associated-interface port1

end

4. Add a firewall address for the web server network.
config firewall address

edit Web-Server-Net
set type ipmask
set subnet 192.168.10.0 255.255.255.0
set associated-interface port2

end

5. Edit the default WAN optimization profile, select transparent mode, enable HTTPWAN optimization and enable
byte caching for HTTP. Leave the HTTP Port set to 80.

config wanopt profile
edit default

set transparent enable
config http

set status enable
set byte-caching enable

end
end

6. Add a WAN optimization security policy to the client-side FortiGate unit to accept the traffic to be optimized:
config firewall policy

edit 0
set srcintf port1
set dstintf port2
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always
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set wanopt enable
set wanopt-profile default
set wanopt-detection off
set wanopt-peer Server-Fgt

end

To configure the server-side FortiGate unit

1. Add the Local Host ID to the server-side FortiGate configuration:
config wanopt settings

set host-id Server-Fgt
end

2. Add the client-side Local Host ID to the server-side peer list:
config wanopt peer

edit Client-Fgt
set ip 192.168.30.12

end

3. Add a WAN optimization tunnel explicit proxy policy.
configure firewall proxy-policy

edit 0
set proxy wanopt
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
end

Testing and troubleshooting the configuration

To test the configuration attempt to start a web browsing session between the client network and the web server
network. For example, from a PC on the client network browse to the IP address of a web server on the web
server network, for example http://192.168.10.100. Even though this address is not on the client network you
should be able to connect to this web server over the WAN optimization tunnel.

If you can connect, checkWAN optimization monitoring. If WAN optimization has been forwarding the traffic the
WAN optimization monitor should show the protocol that has been optimized (in this case HTTP) and the
reduction rate in WAN bandwidth usage.

If you can’t connect you can try the following to diagnose the problem:

l Review your configuration and make sure all details such as address ranges, peer names, and IP addresses are
correct.

l Confirm that the security policy on the client-side FortiGate unit is accepting traffic for the 192.168.10.0 network.
You can do this by checking the policy monitor (Monitor > Firewall User Monitor). Look for sessions that use the
policy ID of this policy.

l Check routing on the FortiGate units and on the client and web server networks to make sure packets can be
forwarded as required. The FortiGate units must be able to communicate with each other, routing on the client
network must allow packets destined for the web server network to be received by the client-side FortiGate unit, and
packets from the server-side FortiGate unit must be able to reach the web servers.
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You can use the following get and diagnose commands to display information about howWAN optimization is
operating.

Enter the following command to list all of the running WAN optimization tunnels and display information about
each one. The command output for the client-side FortiGate unit shows 10 tunnels all created by peer-to-peer
WAN optimization rules (auto-detect set to off).

diagnose wad tunnel list

Tunnel: id=100 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=100 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=348 bytes_out=384

Tunnel: id=99 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=99 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=348 bytes_out=384

Tunnel: id=98 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=98 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=348 bytes_out=384

Tunnel: id=39 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=39 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=1068 bytes_out=1104

Tunnel: id=7 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=7 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=8 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=8 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=5 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=5 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=4 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=4 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264
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Tunnel: id=1 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=1 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=2 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web-servers id=2 ip=192.168.30.12
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnels total=10 manual=10 auto=0

Example Active-passive WAN optimization
In active-passive WAN optimization you add an active WAN optimization policy to the client-side FortiGate unit
and you add a WAN optimization tunnel policy and a passive WAN optimization policy to the server-side
FortiGate unit.

The active policy accepts the traffic to be optimized and sends it down the WAN optimization tunnel to the server-
side FortiGate unit. The active policy can also apply security profiles and other features to traffic before it exits
the client-side FortiGate unit.

A tunnel explicit proxy policy on the sever-side FortiGate unit allows the server-side FortiGate unit to form a WAN
optimization tunnel with the client-side FortiGate unit. The passive WAN optimization policy is required because
of the active policy on the client-side FortiGate unit. You can also use the passive policy to apply WAN
optimization transparent mode and features such as security profiles, logging, traffic shaping and web caching to
the traffic before it exits the server-side FortiGate unit.

Network topology and assumptions

On the client-side FortiGate unit this example configuration includes a WAN optimization profile that optimizes
CIFS, HTTP, and FTP traffic and an active WAN optimization policy. The active policy also applies virus scanning
to the WAN optimization traffic.

On the server-side FortiGate unit, the passive policy applies application control to the WAN optimization traffic.

In this example, WAN optimization transparent mode is selected in the WAN optimization profile and the passive
WAN optimization policy accepts this transparent mode setting. This means that the optimized packets maintain
their original source and destination addresses. As a result, routing on the client network must be configured to
route packets for the server network to the client-side FortiGate unit. Also the routing configuration on the server
network must be able to route packets for the client network to the server-side FortiGate unit.

Example active-passive WAN optimization topology

General configuration steps

This section breaks down the configuration for this example into smaller procedures. For best results, follow the
procedures in the order given:

1. Configure the client-side FortiGate unit:
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l Add peers.
l Add a WAN optimization profile to optimize CIFS, FTP, and HTTP traffic.
l Add firewall addresses for the client and web server networks.
l Add an active WAN optimization policy.

2. Configure the server-side FortiGate unit by:
l Add peers.
l Add firewall addresses for the client and web server networks.
l Add a passive WAN optimization policy.
l Add a WAN optimization tunnel policy.

Configuring basic active-passive WAN optimization - web-based manager

Use the following steps to configure the example WAN optimization configuration from the client-side and server-
side FortiGate unit web-based manager.

To configure the client-side FortiGate unit

1. Go toWAN Opt. & Cache > Peersand enter a Local Host ID for the client-side FortiGate unit:

Local Host ID Client-Fgt

2. Select Apply.
3. Select Create New and add a Peer Host ID and the IP Address for the server-side FortiGate unit:

Peer Host ID Server-Fgt

IP Address 192.168.20.1

4. Select OK.
5. Go toWAN Opt. & Cache > Profilesand select Create New to add a WAN optimization profile to optimize

CIFS, HTTP, and FTP traffic:

Name Custom-wan-opt-pro

Transparent Mode Select

6. Select the CIFS protocol, select Byte Caching and set the Port to 445.
7. Select the FTP protocol, select Byte Caching and set the Port to 21.
8. Select the HTTP protocol, select Byte Caching and set the Port to 80.
9. Select OK.
10. Go to Policy & Objects > Addresses and select Create New to add an address for the client network.

Category Address

Address Name Client-Net

Type IP Range
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Subnet / IP Range 172.20.120.100-172.20.120.200

Interface port1

11. Select Create New to add an address for the web server network.

Category Address

Address Name Web-Server-Net

Type Subnet

Subnet / IP Range 192.168.10.0/24

Interface port2

12. Go to Policy & Objects > IPv4 Policy and select Create New to add an active WAN optimization security
policy:

Incoming Interface port1

Source Address Client-Net

Outgoing Interface port2

Destination Address Web-Server-Net

Schedule always

Service HTTP
FTP
SMB

Action ACCEPT

13. Turn onWAN Optimization and configure the following settings:

WAN Optimization active

Profile Custom-wan-opt-pro

14. Turn on Antivirus and select the default antivirus profile.
15. Select OK.

To configure the server-side FortiGate unit

1. Go toWAN Opt. & Cache > Peersand enter a Local Host ID for the server-side FortiGate unit:

Local Host ID Server-Fgt

2. Select Apply.
3. Select Create New and add a Peer Host ID and the IP Address for the client-side FortiGate unit:
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Peer Host ID Client-Fgt

IP Address 172.30.120.1

4. Select OK.
5. Go to Policy & Objects > Addresses and select Create New to add an address for the client network.

Category Address

Address Name Client-Net

Type IP Range

Subnet / IP Range 172.20.120.100-172.20.120.200

Interface port1

6. Select Create New to add a firewall address for the web server network.

Category Address

Address Name Web-Server-Net

Type Subnet

Subnet / IP Range 192.168.10.0/24

Interface port2

7. Select OK.
8. Select Policy & Objects > IPv4 Policy and select Create New to add a passive WAN optimization policy that

applies application control.

Incoming Interface port2

Source Address Client-Net

Outgoing Interface port1

Destination Address Web-Server-Net

Schedule always

Service ALL

Action ACCEPT

9. Turn onWAN Optimization and configure the following settings:

WAN Optimization passive

Passive Option default
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10. Select OK.
11. From the CLI enter the following command to add a WAN optimization tunnel explicit proxy policy.

configure firewall proxy-policy
edit 0

set proxy wanopt
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
end

Configuring basic active-passive WAN optimization - CLI

Use the following steps to configure the example WAN optimization configuration from the client-side and server-
side FortiGate unit CLI.

To configure the client-side FortiGate unit

1. Add the Local Host ID to the client-side FortiGate configuration:
config wanopt settings

set host-id Client-Fgt
end

2. Add the server-side Local Host ID to the client-side peer list:
config wanopt peer

edit Server-Fgt
set ip 192.168.20.1

end

3. Add a WAN optimization profile to optimize CIFS, HTTP, and FTP traffic.
config wanopt profile

edit Custom-wan-opt-pro
config cifs

set status enable
set byte-caching enable
set port 445

end
config http

set status enable
set byte-caching enable
set port 80

end
config ftp

set status enable
set byte-caching enable
set port 21

end
end

4. Add a firewall address for the client network.
config firewall address

edit Client-Net
set type iprange
set start-ip 172.20.120.100
set end-ip 172.20.120.200
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set associated-interface port1
end

5. Add a firewall address for the web server network.
config firewall address

edit Web-Server-Net
set type ipmask
set subnet 192.168.10.0 255.255.255.0
set associated-interface port2

end

6. Add an active WAN optimization security policy that applies virus scanning:
config firewall policy

edit 0
set srcintf port1
set dstintf port2
set srcaddr Client-net
set dstaddr Web-Server-Net
set action accept
set service HTTP FTP SMB
set schedule always
set wanopt enable
set wanopt-detection active
set wanopt-profile Custom-wan-opt-pro

end

To configure the server-side FortiGate unit

1. Add the Local Host ID to the server-side FortiGate configuration:
config wanopt settings

set host-id Server-Fgt
end

2. Add the client-side Local Host ID to the server-side peer list:
config wanopt peer

edit Client-Fgt
set ip 172.20.120.1

end

3. Add a firewall address for the client network.
config firewall address

edit Client-Net
set type iprange
set start-ip 172.20.120.100
set end-ip 172.20.120.200
set associated-interface port1

end

4. Add a firewall address for the web server network.
config firewall address

edit Web-Server-Net
set type ipmask
set subnet 192.168.10.0 255.255.255.0
set associated-interface port2

end

5. Add a passive WAN optimization policy.
config firewall policy

edit 0
set srcintf port1
set dstintf port2
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set srcaddr Client-Net
set dstaddr Web-Server-Net
set action accept
set service ALL
set schedule always
set wanopt enable
set wanopt-detection passive
set wanopt-passive-opt default

end

6. Add a WAN optimization tunnel explicit proxy policy.
configure firewall proxy-policy

edit 0
set proxy wanopt
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
end

Testing and troubleshooting the configuration

To test the configuration attempt to start a web browsing session between the client network and the web server
network. For example, from a PC on the client network browse to the IP address of a web server on the web
server network, for example http://192.168.10.100. Even though this address is not on the client network you
should be able to connect to this web server over the WAN optimization tunnel.

If you can connect, checkWAN optimization monitoring. If WAN optimization has been forwarding the traffic the
WAN optimization monitor should show the protocol that has been optimized (in this case HTTP) and the
reduction rate in WAN bandwidth usage.

If you can’t connect you can try the following to diagnose the problem:

l Review your configuration and make sure all details such as address ranges, peer names, and IP addresses are
correct.

l Confirm that the security policy on the Client-Side FortiGate unit is accepting traffic for the 192.168.10.0 network
and that this security policy does not include security profiles. You can do this by checking the FortiGate session
table from the dashboard. Look for sessions that use the policy ID of this policy.

l Check routing on the FortiGate units and on the client and web server networks to make sure packets can be
forwarded as required. The FortiGate units must be able to communicate with each other, routing on the client
network must allow packets destined for the web server network to be received by the client-side FortiGate unit, and
packets from the server-side FortiGate unit must be able to reach the web servers etc.

You can use the following get and diagnose commands to display information about howWAN optimization is
operating

Enter the following command to list all of the running WAN optimization tunnels and display information about
each one. The command output shows 3 tunnels all created by peer-to-peer WAN optimization rules (auto-detect
set to on).

diagnose wad tunnel list

Tunnel: id=139 type=auto
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vd=0 shared=no uses=0 state=1
peer name= id=0 ip=unknown
SSL-secured-tunnel=no auth-grp=test
bytes_in=744 bytes_out=76

Tunnel: id=141 type=auto
vd=0 shared=no uses=0 state=1
peer name= id=0 ip=unknown
SSL-secured-tunnel=no auth-grp=test
bytes_in=727 bytes_out=76

Tunnel: id=142 type=auto
vd=0 shared=no uses=0 state=1
peer name= id=0 ip=unknown
SSL-secured-tunnel=no auth-grp=test
bytes_in=727 bytes_out=76

Tunnels total=3 manual=0 auto=3

Example Adding secure tunneling to an active-passive WAN optimization configuration
This example shows how to configure two FortiGate units for active-passive WAN optimization with secure
tunneling. The same authentication group is added to both FortiGate units. The authentication group includes a
password (or pre-shared key) and has Peer Acceptance set to Accept any Peer. An active policy is added to
the client-side FortiGate unit and a passive policy to the server-side FortiGate unit. The active policy includes a
profile that performs secure tunneling, optimizes HTTP traffic, and uses Transparent Mode and byte caching.

The authentication group is named Auth-Secure-Tunnel and the password for the pre-shared key is 2345678.
The topology for this example is shown below. This example includes web-based manager configuration steps
followed by equivalent CLI configuration steps. For information about secure tunneling, see .

Network topology and assumptions

This example configuration includes a client-side FortiGate unit called Client-net with a WAN IP address of
172.30.120.1.This unit is in front of a network with IP address 172.20.120.0. The server-side FortiGate unit is
called Web-servers and has a WAN IP address of 192.168.20.1. This unit is in front of a web server network with
IP address 192.168.10.0.

Example active-passive WAN optimization and secure tunneling topology

General configuration steps

This section breaks down the configuration for this example into smaller procedures. For best results, follow the
procedures in the order given:

1. Configure the client-side FortiGate unit:
l Add peers.
l Add an authentication group.
l Add an active WAN optimization policy.

2. Configure the server-side FortiGate unit.
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l Add peers.
l Add the same authentication group
l Add a passive WAN optimization policy that applies application control.
l Add a WAN optimization tunnel policy.

Also note that if you perform any additional actions between procedures, your configuration may have different
results.

Configuring WAN optimization with secure tunneling - web-based manager

Use the following steps to configure the example WAN optimization configuration from the client-side and server-
side FortiGate unit web-based manager. (CLI steps follow.)

To configure the client-side FortiGate unit

1. Go toWAN Opt. & Cache > Peersand enter a Local Host ID for the client-side FortiGate unit:

Local Host ID Client-Fgt

2. Select Apply to save your setting.
3. Select Create New and add a Peer Host ID and the IP Address for the server-side FortiGate unit:

Peer Host ID Server-Fgt

IP Address 192.168.20.1

4. Select OK.
5. Go toWAN Opt. & Cache > Authentication Groups and select Create New to add the authentication group

to be used for secure tunneling:

Name Auth-Secure-Tunnel

Authentication Method Pre-shared key

Password 2345678

Peer Acceptance Accept Any Peer

6. Select OK.
7. Go toWAN Opt. & Cache > Profiles and select Create New to add a WAN optimization profile that enables

secure tunneling and includes the authentication group:

Name Secure-wan-op-pro

Transparent Mode Select

Authentication Group Auth-Secure-tunnel

8. Select the HTTP protocol, select Secure Tunneling and Byte Caching and set the Port to 80.
9. Select OK.
10. Go to Policy & Objects > Addresses and select Create New to add a firewall address for the client network.
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Category Address

Name Client-Net

Type Subnet

Subnet / IP Range 172.20.120.0/24

Interface port1

11. Select Create New to add a firewall address for the web server network.

Category Address

Address Name Web-Server-Net

Type Subnet

Subnet / IP Range 192.168.10.0/24

Interface port2

12. Go to Policy & Objects > IPv4 Policy and select Create New to add an active WAN optimization security
policy:

Incoming Interface port1

Source Address Client-Net

Outgoing Interface port2

Destination Address Web-Server-Net

Schedule always

Service HTTP

Action ACCEPT

13. Turn onWAN Optimization and configure the following settings:

WAN Optimization active

Profile Secure-wan-opt-pro

14. Select OK.

To configure the server-side FortiGate unit

1. Go toWAN Opt. & Cache > Peersand enter a Local Host ID for the server-side FortiGate unit:

Local Host ID Server-Fgt
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2. Select Apply to save your setting.
3. Select Create New and add a Peer Host ID and the IP Address for the client-side FortiGate unit:

Peer Host ID Client-Fgt

IP Address 172.30.120.1

4. Select OK.
5. Go toWAN Opt. & Cache > Authentication Groups and select Create New and add an authentication group

to be used for secure tunneling:

Name Auth-Secure-Tunnel

Authentication Method Pre-shared key

Password 2345678

Peer Acceptance Accept Any Peer

6. Select OK.
7. Go to Policy & Objects > Addresses and select Create New to add a firewall address for the client network.

Category Address

Name Client-Net

Type Subnet

Subnet / IP Range 172.20.120.0/24

Interface port1

8. Select Create New to add a firewall address for the web server network.

Category Address

Address Name Web-Server-Net

Type Subnet

Subnet / IP Range 192.168.10.0/24

Interface port2

9. Select OK.
10. Select Create New to add a passive WAN optimization policy that applies application control.

Incoming Interface port2

Source Address Client-Net
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Outgoing Interface port1

Destination Address Web-Server-Net

Schedule always

Service ALL

Action ACCEPT

11. Turn onWAN Optimization and configure the following settings:

WAN Optimization passive

Passive Option default

12. Select OK.
13. From the CLI enter the following command to add a WAN optimization tunnel explicit proxy policy.

configure firewall proxy-policy
edit 0

set proxy wanopt
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
end

Configuring WAN optimization with secure tunneling - CLI

Use the following steps to configure the example WAN optimization configuration from the client-side and server-
side FortiGate unit CLI.

To the client-side FortiGate unit

1. Add the Local Host ID to the client-side FortiGate configuration:
config wanopt settings

set host-id Client-Fgt
end

2. Add the server-side Local Host ID to the client-side peer list:
config wanopt peer

edit Server-Fgt
set ip 192.168.20.1

end

3. Add a new authentication group to be used for secure tunneling:
config wanopt auth-group

edit Auth-Secure-Tunnel
set auth-method psk
set psk 2345678

end
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Leave peer-accept at its default value.

4. Add a WAN optimization profile that enables secure tunneling and includes the authentication group, enables
HTTP protocol optimization, and enables secure tunneling and byte caching for HTTP traffic:

config wanopt profile
edit Secure-wan-op-pro

set auth-group Auth-Secure-Tunnel
config http

set status enable
set secure-tunnel enable
set byte-caching enable
set port 80

end
end

5. Add a firewall address for the client network.
config firewall address

edit Client-Net
set type ipmask
set subnet 172.20.120.0 255.255.255.0
set associated-interface port1

end

6. Add a firewall address for the web server network.
config firewall address

edit Web-Server-Net
set type ipmask
set subnet 192.168.10.0 255.255.255.0
set associated-interface port2

end

7. Add an active WAN optimization security policy that includes the WAN optimization profile that enables secure
tunneling and that applies virus scanning:

config firewall policy
edit 0

set srcintf port1
set dstintf port2
set srcaddr Client-Net
set dstaddr Web-Server-Net
set action accept
set service HTTP
set schedule always
set wanopt enable
set wanopt-detection active
set wanopt-profile Secure-wan-opt-pro

end

To configure the server-side FortiGate unit

1. Add the Local Host ID to the server-side FortiGate configuration:
config wanopt settings

set host-id Server-Fgt
end

2. Add the client-side Local Host ID to the server-side peer list:
config wanopt peer
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edit Client-Fgt
set ip 172.20.120.1

end

3. Add an authentication group to be used for secure tunneling:
config wanopt auth-group

edit Auth-Secure-Tunnel
set auth-method psk
set psk 2345678

end

Leave peer-accept at its default value.

4. Add a firewall address for the client network.
config firewall address

edit Client-Net
set type ipmask
set subnet 172.20.120.0 255.255.255.0
set associated-interface port1

end

5. Add a firewall address for the web server network.
config firewall address

edit Web-Server-Net
set type ipmask
set subnet 192.168.10.0 255.255.255.0
set associated-interface port2

end

6. Add a passive WAN optimization policy.
config firewall policy

edit 0
set srcintf port1
set dstintf port2
set srcaddr Client-Net
set dstaddr Web-Server-Net
set action accept
set service ALL
set schedule always
set wanopt enable
set wanopt-detection passive
set wanopt-passive-opt default

end

7. Add a WAN optimization tunnel explicit proxy policy.
configure firewall proxy-policy

edit 0
set proxy wanopt
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
end
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Peers and authentication groups

All communication between WAN optimization peers begins with one WAN optimization peer (or client-side
FortiGate unit) sending a WAN optimization tunnel request to another peer (or server-side FortiGate unit). During
this process, the WAN optimization peers identify and optionally authenticate each other.

Basic WAN optimization peer requirements
WAN optimization requires the following configuration on each peer. For information about configuring local and
peer host IDs, see Basic WAN optimization peer requirements on page 1154.

l The peer must have a unique host ID.
l Unless authentication groups are used, peers authenticate each other using host ID values. Do not leave the local

host ID at its default value.
l The peer must know the host IDs and IP addresses of all of the other peers that it can start WAN optimization

tunnels with. This does not apply if you use authentication groups that accept all peers.
l All peers must have the same local certificate installed on their FortiGate units if the units authenticate by local

certificate. Similarly, if the units authenticate by pre-shared key (password), administrators must know the
password. The type of authentication is selected in the authentication group. This applies only if you use
authentication groups.

Accepting any peers

Strictly speaking, you do not need to add peers. Instead you can configure authentication groups that accept any
peer. However, for this to work, both peers must have the same authentication group (with the same name) and
both peers must have the same certificate or pre-shared key.

Accepting any peer is useful if you have many peers or if peer IP addresses change. For example, you could have
FortiGate units with dynamic external IP addresses (using DHCP or PPPoE). For most other situations, this
method is not recommended and is not a best practice as it is less secure than accepting defined peers or a single
peer. For more information, see Basic WAN optimization peer requirements on page 1154.

How FortiGate units process tunnel requests for peer authentication
When a client-side FortiGate unit attempts to start a WAN optimization tunnel with a peer server-side FortiGate
unit, the tunnel request includes the following information:

l the client-side local host ID
l the name of an authentication group, if included in the rule that initiates the tunnel
l if an authentication group is used, the authentication method it specifies: pre-shared key or certificate
l the type of tunnel (secure or not).

For information about configuring the local host ID, peers and authentication groups, see How FortiGate units
process tunnel requests for peer authentication on page 1154 and How FortiGate units process tunnel requests
for peer authentication on page 1154.

The authentication group is optional unless the tunnel is a secure tunnel. For more information, see How
FortiGate units process tunnel requests for peer authentication on page 1154.
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If the tunnel request includes an authentication group, the authentication will be based on the settings of this
group as follows:

l The server-side FortiGate unit searches its own configuration for the name of the authentication group in the tunnel
request. If no match is found, the authentication fails.

l If a match is found, the server-side FortiGate unit compares the authentication method in the client and server
authentication groups. If the methods do not match, the authentication fails.

l If the authentication methods match, the server-side FortiGate unit tests the peer acceptance settings in its copy of
the authentication group.

l If the setting isAccept Any Peer, the authentication is successful.
l If the setting is Specify Peer, the server-side FortiGate unit compares the client-side local host ID in the tunnel

request with the peer name in the server-side authentication group. If the names match, authentication is
successful. If a match is not found, authentication fails.

l If the setting isAccept Defined Peers, the server-side FortiGate unit compares the client-side local host ID in the
tunnel request with the server-side peer list. If a match is found, authentication is successful. If a match is not
found, authentication fails.

If the tunnel request does not include an authentication group, authentication will be based on the client-side
local host ID in the tunnel request. The server-side FortiGate unit searches its peer list to match the client-side
local host ID in the tunnel request. If a match is found, authentication is successful. If a match is not found,
authentication fails.

If the server-side FortiGate unit successfully authenticates the tunnel request, the server-side FortiGate unit
sends back a tunnel setup response message. This message includes the server-side local host ID and the
authentication group that matches the one in the tunnel request.

The client-side FortiGate unit then performs the same authentication procedure as the server-side FortiGate unit
did. If both sides succeed, tunnel setup continues.

Configuring peers
When you configure peers, you first need to add the local host ID that identifies the FortiGate unit for WAN
optimization and then add the peer host ID and IP address of each FortiGate unit with which a FortiGate unit can
create WAN optimization tunnels.

To configure WAN optimization peers - web-based manager:

1. Go toWAN Opt. & Cache > Peers.
2. For Local Host ID, enter the local host ID of this FortiGate unit and select Apply. If you add this FortiGate unit

as a peer to another FortiGate unit, use this ID as its peer host ID.

The local or host ID can contain up to 25 characters and can include spaces.
3. Select Create New to add a new peer.
4. For Peer Host ID, enter the peer host ID of the peer FortiGate unit. This is the local host ID added to the peer

FortiGate unit.
5. For IP Address, add the IP address of the peer FortiGate unit. This is the source IP address of tunnel requests

sent by the peer, usually the IP address of the FortiGate interface connected to the WAN.
6. Select OK.
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To configure WAN optimization peers - CLI:

In this example, the local host ID is named HQ_Peer and has an IP address of 172.20.120.100. Three peers
are added, but you can add any number of peers that are on the WAN.

1. Enter the following command to set the local host ID to HQ_Peer.
config wanopt settings

set host-id HQ_peer
end

2. Enter the following commands to add three peers.
config wanopt peer

edit Wan_opt_peer_1
set ip 172.20.120.100

next
edit Wan_opt_peer_2

set ip 172.30.120.100
next
edit Wan_opt_peer_3

set ip 172.40.120.100
end

Configuring authentication groups
You need to add authentication groups to support authentication and secure tunneling between WAN
optimization peers.

To perform authentication, WAN optimization peers use a certificate or a pre-shared key added to an
authentication group so they can identify each other before forming a WAN optimization tunnel. Both peers must
have an authentication group with the same name and settings. You add the authentication group to a peer-to-
peer or active rule on the client-side FortiGate unit. When the server-side FortiGate unit receives a tunnel start
request from the client-side FortiGate unit that includes an authentication group, the server-side FortiGate unit
finds an authentication group in its configuration with the same name. If both authentication groups have the
same certificate or pre-shared key, the peers can authenticate and set up the tunnel.

Authentication groups are also required for secure tunneling.

To add authentication groups, go toWAN Opt. & Cache > Authentication Groups.

To add an authentication group - web-based manager:

Use the following steps to add any kind of authentication group. It is assumed that if you are using a local
certificate to authenticate, it is already added to the FortiGate unit

1. Go toWAN Opt. & Cache > Authentication Groups.
2. Select Create New.
3. Add a Name for the authentication group.

You will select this name when you add the authentication group to a WAN optimization rule.
4. Select the Authentication Method.

Select Certificate if you want to use a certificate to authenticate and encrypt WAN optimization tunnels. You must
select a local certificate that has been added to this FortiGate unit. (To add a local certificate, go to System
> Certificates.) Other FortiGate units that participate in WAN optimization tunnels with this FortiGate unit must
have an authentication group with the same name and certificate.
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Select Pre-shared key if you want to use a pre-shared key or password to authenticate and encrypt WAN
optimization tunnels. You must add the Password (or pre-shared key) used by the authentication group. Other
FortiGate units that participate in WAN optimization tunnels with this FortiGate unit must have an authentication
group with the same name and password. The password must contain at least 6 printable characters and should
be known only by network administrators. For optimum protection against currently known attacks, the key should
consist of a minimum of 16 randomly chosen alphanumeric characters.

5. Configure Peer Acceptance for the authentication group.

Select Accept Any Peer if you do not know the peer host IDs or IP addresses of the peers that will use this
authentication group. This setting is most often used for WAN optimization with FortiGate units that do not have
static IP addresses, for example units that use DHCP.

Select Accept Defined Peers if you want to authenticate with peers added to the peer list only.

Select Specify Peer and select one of the peers added to the peer list to authenticate with the selected peer only.

6. Select OK.
7. Add the authentication group to a WAN optimization rule to apply the authentication settings in the authentication

group to the rule.

To add an authentication group that uses a certificate- CLI:

Enter the following command to add an authentication group that uses a certificate and can authenticate all peers
added to the FortiGate unit configuration.

In this example, the authentication group is named auth_grp_1 and uses a certificate named Example_
Cert.

config wanopt auth-group
edit auth_grp_1

set auth-method cert
set cert Example_Cert
set peer-accept defined

end

To add an authentication group that uses a pre-shared key - CLI:

Enter the following command to add an authentication group that uses a pre-shared key and can authenticate
only the peer added to the authentication group.

In this example, the authentication group is named auth_peer, the peer that the group can authenticate is
named Server_net, and the authentication group uses 123456 as the pre-shared key. In practice you should
use a more secure pre-shared key.

config wanopt auth-group
edit auth_peer

set auth-method psk
set psk 123456
set peer-accept one
set peer Server_net

end
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To add an authentication group that accepts WAN optimization connections from any peer - web-based
manager

Add an authentication group that accepts any peer for situations where you do not have the Peer Host IDs or IP
Addresses of the peers that you want to perform WAN optimization with. This setting is most often used with
FortiGate units that do not have static IP addresses, for example units that use DHCP. An authentication group
that accepts any peer is less secure than an authentication group that accepts defined peers or a single peer.

The example below sets the authentication method to Pre-shared key. You must add the same password to all
FortiGate units using this authentication group.

1. Go toWAN Opt. & Cache > Authentication Groups.
2. Select Create New to add a new authentication group.
3. Configure the authentication group:

Name Specify any name.

Authentication Method Pre-shared key

Password Enter a pre-shared key.

Peer Acceptance Accept Any Peer

To add an authentication group that accepts WAN optimization connections from any peer - CLI:

In this example, the authentication group is named auth_grp_1. It uses a certificate named WAN_Cert and
accepts any peer.

config wanopt auth-group
edit auth_grp_1

set auth-method cert
set cert WAN_Cert
set peer-accept any

end

Secure tunneling
You can configure WAN optimization rules to use AES-128bit-CBC SSL to encrypt the traffic in the WAN
optimization tunnel. WAN optimization uses FortiASIC acceleration to accelerate SSL decryption and encryption
of the secure tunnel. Peer-to-peer secure tunnels use the same TCP port as non-secure peer-to-peer tunnels
(TCP port 7810).

To use secure tunneling, you must select Enable Secure Tunnel in a WAN optimization rule and add an
authentication group. The authentication group specifies the certificate or pre-shared key used to set up the
secure tunnel. The Peer Acceptance setting of the authentication group does not affect secure tunneling.

The FortiGate units at each end of the secure tunnel must have the same authentication group with the same
name and the same configuration, including the same pre-shared key or certificate. To use certificates you must
install the same certificate on both FortiGate units.

For active-passive WAN optimization you can select Enable Secure Tunnel only in the active rule. In peer-to-
peer WAN optimization you select Enable Secure Tunnel in the WAN optimization rule on both FortiGate units.
For information about active-passive and peer-to-peer WAN optimization, see

For a secure tunneling configuration example, see .
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Monitoring WAN optimization peer performance
The WAN optimization peer monitor lists all of the WAN optimization peers that a FortiGate unit can perform
WAN optimization with. These include peers manually added to the configuration as well as discovered peers.

The monitor lists each peer’s name, IP address, and peer type. The peer type indicates whether the peer was
manually added or discovered. To showWAN optimization performance, for each peer the monitor lists the
percent of traffic reduced by the peer in client-side WAN optimization configurations and in server-side
configurations (also called gateway configurations).

To view the peer monitor, go toWAN Opt. & Cache > Peer Monitor.

Web Cache Concepts

FortiGate web caching is a form of object caching that accelerates web applications and web servers by reducing
bandwidth usage, server load, and perceived latency. Web caching supports caching of HTTP 1.0 and HTTP 1.1
web sites. See RFC 2616 for information about web caching for HTTP 1.1.

Web caching supports caching of Flash content over HTTP but does not cache audio
and video streams including Flash videos and streaming content that use native
streaming protocols such as RTMP.

The first time a file is received by web caching it is cached in the format it is received
in, whether it be compressed or uncompressed. When the same file is requested by a
client but in a different compression format, the cached file is converted to the new
compressed format before being sent to the client.

There are three significant advantages to using web caching to improve HTTP and WAN performance:

l reduced bandwidth consumption because fewer requests and responses go over the WAN or Internet.
l reduced web server load because there are fewer requests for web servers to handle.
l reduced latency because responses for cached requests are available from a local FortiGate unit instead of from

across the WAN or Internet.

You can use web caching to cache any web traffic that passes through the FortiGate unit, including web pages
from web servers on a LAN, WAN or on the Internet. You apply web caching by enabling the web caching option
in any security policy. When enabled in a security policy, web caching is applied to all HTTP sessions accepted by
the security policy. If the security policy is an explicit web proxy security policy, the FortiGate unit caches explicit
web proxy sessions.

Turning on web caching for HTTP and HTTPS traffic
Web caching can be applied to any HTTP or HTTPS traffic by enabling web caching in a security policy that
accepts the traffic. This includes IPv4, IPv6, WAN optimization and explicit web proxy traffic. Web caching caches
all HTTP traffic accepted by a policy on TCP port 80.

You can add web caching to a policy to:

l Cache Internet HTTP traffic for users on an internal network to reduce Internet bandwidth use. Do this by selecting
the web cache option for security policies that allow users on the internal network to browse web sites on the
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Internet.
l Reduce the load on a public facing web server by caching objects on the FortiGate unit. This is a reverse proxy with

web caching configuration. Do this by selecting the web cache option for a security policy that allows users on the
Internet to connect to the web server.

l Cache outgoing explicit web proxy traffic when the explicit proxy is used to proxy users in an internal network who
are connecting to the web servers on the Internet. Do this by selecting the web cache option for explicit web proxy
security policies that allow users on the internal network to browse web sites on the Internet.

l Combine web caching with WAN optimization. You can enable web caching in anyWAN optimization security
policy. This includes manual, active, and passive WAN optimization policies and WAN optimization tunnel policies.
You can enable web caching on both the client-side and the server-side FortiGate units or on just one or the other.
For optimum performance you can enable web caching on both the client-side and server-side FortiGate units. In
this way only uncached content is transmitted through the WAN optimization tunnel. All cached content is access
locally by clients from the client side FortiGate unit.

One important use for web caching is to cache software updates (for example,
Windows Updates or iOS updates. When updates occur a large number of users may
all be trying to download these updates at the same time. Caching these updates will
be a major performance improvement and also have a potentially large impact on
reducing Internet bandwidth use. You may want to adjust the maximum cache object
size to make sure these updates are cached. See Turning on web caching for HTTP
and HTTPS traffic on page 1159.

Turning on web caching for HTTPS traffic
Web caching can also cache the content of HTTPS traffic on TCP port 443. With HTTPSweb caching, the
FortiGate unit receives the HTTPS traffic on behalf of the client, opens up the encrypted traffic and extracts
content to be cached. Then FortiGate unit re-encrypts the traffic and sends it on to its intended recipient. It is very
similar to a man-in-the-middle attack.

You enable HTTPSweb caching from the CLI in a security policy or an explicit proxy policy that accepts the traffic
to be cached using webcache-https. For a firewall policy:

config firewall policy
edit 0

.

.

.
set webcache enable
set webcache-https enable
.
.
.

end

For an explicit web proxy policy:

config firewall proxy-policy
edit 0

set proxy explicit-web
.
.
.
set webcache enable
set webcache-https enable

1160 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 9 - Firewall Web Cache Concepts

.

.

.
end

The webcache-https field is available only if webcache is enabled.

Web caching for HTTPS traffic is not supported if WAN optimization or FTP proxy is
enabled: i.e., if srcintf is ftp-proxy or wanopt.

The any setting causes the FortiGate unit to re-encrypt the traffic with the FortiGate unit’s certificate rather than
the original certificate. This configuration can cause errors for HTTPS clients because the name on the certificate
does not match the name on the web site.

You can stop these errors from happening by configuring HTTPSweb caching to use the web server’s certificate
by setting webcache-https to ssl-server. This option is available for both firewall policies and explicit web
proxy policies.

config firewall policy
edit 0

.

.

.
set webcache enable
set webcache-https enable
.
.
.

end

The ssl-server option causes the FortiGate unit to re-encrypt the traffic with a certificate that you imported
into the FortiGate unit. You can add certificates using the following command:

config firewall ssl-server
edit corporate-server

set ip <Web-Server-IP>
set port 443
set ssl-mode { full | half}
set ssl-cert <Web-Server-Cert>

end

Where:

Web-Server-IP is the web server’s IP address.

Web-Server-Cert is a web server certificate imported into the FortiGate unit.

The SSL server configuration also determines whether the SSL server is operating in half or full mode and the
port used for the HTTPS traffic.

You can add multiple SSL server certificates in this way. When web caching processing an SSL stream if it can
find a certificate that matches the web server IP address and port of one of the added SSL servers; that certificate
is used to encrypt the SSL traffic before sending it to the client. As a result the client does not generate SSL
certificate errors.

Web caching uses the FortiGate unit’s FortiASIC to accelerate SSL decryption/encryption performance.
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Full mode SSL server configuration

The ssl-mode option determines whether the SSL server operates in half or full mode. In full mode the
FortiGate unit performs both decryption and encryption of the HTTPS traffic. The full mode sequence is shown
below.

Full mode SSL server configuration

In full mode the FortiGate unit is acting as a man in the middle, decrypting and encrypting the traffic. So both the
client and the web server see encrypted packets.

Usually the port of the encrypted HTTPS traffic is always 443. However, in the SSL server configuration you can
set the port used for HTTPS traffic. This port is not altered by the SSL Server. So for example, if the SSL Server
receives HTTPS traffic on port 443, the re-encrypted traffic forwarded to the FortiGate unit to the server or client
will still use port 443.

Half mode SSL server configuration

In half mode, the FortiGate unit only performs one encryption or decryption action. If HTTP packets are received,
the half mode SSL server encrypts them and converts them to HTTPS packets. If HTTPS packets are received,
the SSL server decrypts them and converts them to HTTP packets.

Half mode SSL server configuration

In half mode, the FortiGate unit is acting like an SSL accelerator, offloading HTTPS decryption from the web
server to the FortiGate unit. Since FortiGate units can accelerate SSL processing, the end result could be
improved web site performance.

Usually the port of the encrypted traffic is always 443. However, in the SSL server configuration you can set the
port used for HTTPS traffic. No matter what port is used for the HTTPS traffic, the decrypted HTTP traffic uses
port 80.

Changing the ports on which to look for HTTP and HTTPS traffic to cache
By default FortiOS assumes HTTP traffic uses TCP port 80 and HTTPS traffic uses port 443. So web caching
caches all HTTP traffic accepted by a policy on TCP port 80 and all HTTPS traffic on TCP port 443. If you want to
cache HTTP or HTTPS traffic on other ports, you can enable security profiles for the security policy and configure
a proxy options profile to that looks for HTTP and HTTPS traffic on other TCP ports. To configure a proxy options
profile go to Network > Explicit Proxy.

Setting the HTTP port to Any in a proxy options profile is not compatible with web caching. If you set the HTTP
port to any, web caching only caches HTTP traffic on port 80.

Web caching and HA
You can configure web caching on a FortiGate HA cluster. The recommended best practice HA configuration for
web caching is active-passive mode. When the cluster is operating, all web caching sessions are processed by the
primary unit only. Even if the cluster is operating in active-active mode, HA does not load-balance web caching
sessions.
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In a cluster, only the primary unit stores the web cache database. The databases is not synchronized to the
subordinate units. So, after a failover, the new primary unit must build its web cache.

Web caching and memory usage
To accelerate and optimize disk access and to provide better throughput and less latency, web caching uses
provisioned memory to reduce disk I/O and increase disk I/O efficiency. In addition, web caching requires a small
amount of additional memory per session for comprehensive flow control logic and efficient traffic forwarding.

When web caching is enabled you will see a reduction in available memory. The reduction increases when more
web caching sessions are being processed. If you are thinking of enabling web caching on an operating FortiGate
unit, make sure its memory usage is not maxed out during high traffic periods.

In addition to using the system dashboard to see the current memory usage you can use the get test wad 2
command to see how much memory is currently being used by web caching. See for more information.

Changing web cache settings
In most cases, the default settings for the WAN optimization web cache are acceptable. However, you may want
to change them to improve performance or optimize the cache for your configuration. To change these settings,
go toWAN Opt. & Cache > Settings.

From the FortiGate CLI, you can use the config wanopt webcache command to change these WAN
optimization web cache settings.

For more information about many of these web cache settings, see RFC 2616.

Always revalidate

Select to always revalidate requested cached objects with content on the server before serving them to the client.

Max cache object size

Set the maximum size of objects (files) that are cached. The default size is 512000 KB and the range is 1 to
4294967 KB. This setting determines the maximum object size to store in the web cache. Objects that are larger
than this size are still delivered to the client but are not stored in the FortiGate web cache.

For most web traffic the default maximum cache object size is recommended. However, since web caching can
also cache larger objects such asWindows updates, Mac OS updates, iOS updates or other updates delivered
using HTTP you might want to increase the object size to make sure these updates are cached. Caching these
updates can save a lot of Internet bandwidth and improve performance when major updates are released by
these vendors.

Negative response duration

Set how long in minutes that the FortiGate unit caches error responses from web servers. If error responses are
cached, then subsequent requests to the web cache from users will receive the error responses regardless of the
actual object status.
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The default is 0, meaning error responses are not cached. The content server might send a client error code (4xx
HTTP response) or a server error code (5xx HTTP response) as a response to some requests. If the web cache is
configured to cache these negative responses, it returns that response in subsequent requests for that page or
image for the specified number of minutes.

Fresh factor

Set the fresh factor as a percentage. The default is 100, and the range is 1 to 100%. For cached objects that do
not have an expiry time, the web cache periodically checks the server to see if the objects have expired. The
higher the Fresh Factor the less often the checks occur.

For example, if you set the Max TTL value and Default TTL to 7200 minutes (5 days) and set the Fresh Factor
to 20, the web cache check the cached objects 5 times before they expire, but if you set the Fresh Factor to 100,
the web cache will check once.

Max TTL

The maximum amount of time (Time to Live) an object can stay in the web cache without the cache checking to
see if it has expired on the server. The default is 7200 minutes (120 hours or 5 days) and the range is 1 to
5256000 minutes (5256000 minutes in a year).

Min TTL

The minimum amount of time an object can stay in the web cache before the web cache checks to see if it has
expired on the server. The default is 5 minutes and the range is 1 to 5256000 minutes (5256000 minutes in a
year).

Default TTL

The default expiry time for objects that do not have an expiry time set by the web server. The default expiry time
is 1440 minutes (24 hours) and the range is 1 to 5256000 minutes (5256000 minutes in a year).

Proxy FQDN

The fully qualified domain name (FQDN) for the proxy server. This is the domain name to enter into browsers to
access the proxy server. This field is for information only can be changed from the explicit web proxy
configuration.

Max HTTP request length

The maximum length of an HTTP request that can be cached. Larger requests will be rejected. This field is for
information only can be changed from the explicit web proxy configuration.

Max HTTP message length

The maximum length of an HTTPmessage that can be cached. Larger messages will be rejected. This field is for
information only can be changed from the explicit web proxy configuration.

Ignore

Select the following options to ignore some web caching features.
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If-modified-since By default, if the time specified by the if-modified-since (IMS) header in the client's
conditional request is greater than the last modified time of the object in the cache, it
is a strong indication that the copy in the cache is stale. If so, HTTP does a conditional
GET to the Overlay Caching Scheme (OCS), based on the last modified time of the
cached object. Enable ignoring if-modified-since to override this behavior.

HTTP 1.1
conditionals

HTTP 1.1 provides additional controls to the client over the behavior of caches toward
stale objects. Depending on various cache-control headers, the FortiGate unit can be
forced to consult the OCS before serving the object from the cache. For more
information about the behavior of cache-control header values, see RFC 2616.Enable
ignoring HTTP 1.1 Conditionals to override this behavior.

Pragma-no-cache Typically, if a client sends an HTTPGET request with a pragma no-cache (PNC) or
cache-control no-cache header, a cache must consult the OCS before serving the
content. This means that the FortiGate unit always re-fetches the entire object from
the OCS, even if the cached copy of the object is fresh. Because of this behavior, PNC
requests can degrade performance and increase server-side bandwidth utilization.
However, if you enable ignoring Pragma-no-cache, then the PNC header from the
client request is ignored. The FortiGate unit treats the request as if the PNC header is
not present.

IE Reload

Some versions of Internet Explorer issue Accept / header instead of Pragma no-cache
header when you select Refresh. When an Accept header has only the / value, the
FortiGate unit treats it as a PNC header if it is a type-N object. Enable ignoring IE
reload to cause the FortiGate unit to ignore the PNC interpretation of the Accept /
header.

Cache Expired Objects

Applies only to type-1 objects. When this option is selected, expired type-1 objects are cached (if all other
conditions make the object cacheable).

Revalidated Pragma-no-cache

The pragma-no-cache (PNC) header in a client's request can affect how efficiently the FortiGate unit uses
bandwidth. If you do not want to completely ignore PNC in client requests (which you can do by selecting to
ignore Pragma-no-cache, above), you can nonetheless lower the impact on bandwidth usage by selecting
Revalidate Pragma-no-cache.

When you select Revalidate Pragma-no-cache, a client's non-conditional PNC-GET request results in a
conditional GET request sent to the OCS if the object is already in the cache. This gives the OCS a chance to
return the 304 Not Modified response, which consumes less server-side bandwidth, because the OCS has not
been forced to otherwise return full content.

By default, Revalidate Pragma-no-cache is disabled and is not affected by changes in the top-level profile.

Most download managers make byte-range requests with a PNC header. To serve such requests from the cache,
you should also configure byte-range support when you configure the Revalidate pragma-no-cache option.
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Web Cache Configuration

Forwarding URLs to forwarding servers and exempting web sites from web caching
You can go to Network > Explicit Proxy and use the URL match list to forward URL patterns to forwarding
servers and create a list of URLs that are exempt from web caching.

Forwarding URLs and URL patterns to forwarding servers

As part of configuring the explicit web proxy you can configure proxy chaining by adding web proxy forwarding
servers. See Proxy chaining (web proxy forwarding servers) .

You can then use the URL match list to always forward explicit web proxy traffic destined for configured URLs or
URL patterns to one of these forwarding servers. For example, you might want to forward all traffic for a specific
country to a proxy server located in that country.

To forward traffic destined for a URL to a forwarding server that you have already added, go to Network
> Explicit Proxy and select Create New. Add a name for the URL match entry and enter the URL or URL
pattern. You can use wildcards such as * and ? and you can use a numeric IP address. Select Forward to Server
and select a web proxy forwarding server from the list.

You can also exempt the URL or URL pattern from web caching.

Use the following command to forward all .ca traffic to a proxy server and all .com traffic to another proxy server.

config web-proxy url-match
edit "com"

set forward-server "server-commercial"
set url-pattern "com"

next
edit "ca"

set forward-server "server-canada"
set url-pattern "ca"

next
edit "www.google.ca"

set cache-exemption enable
set url-pattern "www.google.ca"

next
end

Exempting web sites from web caching

You may want to exempt some URLs from web caching for a number of reasons. For example, if your users
access websites that are not compatible with FortiGate web caching you can add the URLs of these web sites to
the web caching exempt list. You can add URLs and numeric IP addresses to the web cache exempt list.

You can also add URLs to the web cache exempt list by going to Network > Explicit Proxy, going to the URL
Match List
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and selecting Create New. Add a URL pattern to be exempt and select Exempt from Cache.

You can also add URLs and addresses to be exempt from caching using the CLI. Enter the following command to
add www.example.com to the web cache exempt list:

config web-proxy url-match
set cache-exemption enable
set url-pattern www.example.com

end

Exempting specific files from caching

You can exempt files from being cached, so long as you specify its full URL. Enter the following command to add
the URL, with the file extension (in this example, .exe), to the web cache exempt list:

config web-proxy url-match
edit "exe"

set url-pattern "iavs9x.u.avast.com/custom/iavs9x/20160613t1237z/avast_free_
antivirus_setup_online.exe"

set cache-exemption enable
next

end

You cannot use wildcards to exempt file extensions in general from caching.
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Monitoring Web caching performance
The web cache monitor shows the percentage of web cache requests that retrieved content from the cache (hits)
and the percentage that did not receive content from the cache (misses). A higher the number of hits usually
indicates that the web cache is being more effective at reducing WAN traffic.

The web cache monitor also shows a graph of web traffic on the WAN and LAN. A lower WAN line on the graph
indicates the web cache is reducing traffic on the WAN. The web cache monitor also displays the total number of
web requests processed by the web cache.

To view the web cache monitor, go toMonitor > Cache Monitor.

Web cache monitor

Example Web caching of HTTP and HTTPS Internet content for users on an internal
network

This example describes how to configure web caching of HTTP and HTTPS for users on a private network
connecting to the Internet.

Network topology and assumptions

This example includes a client network with subnet address 10.31.101.0 connecting to web servers on the
Internet. All of the users on the private network access the Internet though a single general security policy on the
FortiGate unit that accepts all sessions connecting to the Internet. Web caching for HTTP and HTTPS traffic is
added to this security policy.

Since users on the private network have unrestricted access to the Internet and can be accessing many web
servers the webcache-https is set to any and users may see error messages on their web browsers when
accessing HTTPS content.

The GUI is less versatile than the CLI so the example instructions for the GUI give settings for one port for each
protocol, while the CLI example shows how to use multiple ports.

The example also describes how to configure the security policy to cache HTTP traffic on port 80 and 8080 in the
CLI, by adding a proxy options profile that looks for HTTP traffic on TCP ports 80 and 8080. The example also
describes how to configure the security policy to cache HTTPS traffic on port 443 and 8443 using the same proxy
options profile.

Example web caching topology

General configuration steps

This section breaks down the configuration for this example into smaller procedures. For best results, follow the
procedures in the order given:

1. Add HTTPweb caching to the security policy that all users on the private network use to connect to the Internet.
2. Add HTTPSweb caching.
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3. Add a protocol options profile to look for HTTP traffic on ports 80 and 8080 and HTTPS traffic on ports 443 and
8443 and add this protocol options profile to the security policy.

If you perform any additional actions between procedures, your configuration may have different results.

Configuration Steps - web-based manager

Use the following steps to configure the example configuration from the FortiGate web-based manager.

To add HTTP web caching to a security policy

1. Go to Policy & Objects > IPv4 Policyand add a security policy that allows all users on the internal network to
access the Internet.

Incoming Interface Internal

Outgoing Interface wan1

Source all

Destination all

Schedule always

Service ALL

Action ACCEPT

2. Toggle NAT to enabled, and select Use Outgoing Interface Address.
3. Turn onWeb cache.
4. Select OK.

To add HTTPS web caching

1. From the CLI enter the following command to add HTTPSweb caching to the policy.

Assume the index number of the policy is 5.
config firewall policy

edit 5
set webcache-https any

end

To cache HTTP traffic on port 80 and HTTPS on 8443

1. Go to Network > Explicit Proxy and edit the Explicit Proxy options profile.
2. Under Explicit Web Proxy ,
l For the HTTP port, enter 80.
l ForHTTPS port, select Specify and enter 8443 in the field.
3. Click on Apply.
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You need to use the CLI to add the protocol options profile unless you also add a
security profile that uses proxy-based inspection.

Configuration Steps - CLI

Use the following steps to configure the example configuration from the FortiGate CLI.

To add HTTP and HTTPS web caching to a security policy

1. Enter the following command to add a security policy that allows all users on the internal network to access the
Internet and that includes web caching of HTTP and HTTPS traffic.

config firewall policy
edit 0

set srcintf internal
set srcaddr all
set dstintf wan1
set distinf all
set schedule always
set service ALL
set action accept
set nat enable
set webcache enable
set webcache-https any

end

To cache HTTP traffic on port 80 and 8080 and HTTPS traffic on ports 443 and 8443

1. Enter the following command to edit the default proxy options profile to configure it to look for HTTP traffic on
ports 80 and 8080:

config firewall profile-protocol-options
edit default

config http
set status enable
set ports 80 8080

end

2. Enter the following command to edit the certification-inspection SSL SSH options profile to configure it to look
for HTTPS traffic on ports 443 and 8443:

config firewall ssl-ssh-profile
edit certificate-inspection

config https
set status certificate-inspection
set ports 443 8443

end

3. Enter the following command to add the default proxy options profile and the certificate-inspection SSL SSH
profile to the firewall policy.

config firewall policy
edit 5

set utm-status enable
set profile-protocol-options default
set ssl-ssh-profile certificate-inspection

1170 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 9 - Firewall Web Cache Configuration

end

Example reverse proxy web caching and SSL offloading for an Internet web server using a
static one-to-one virtual IP

This section describes configuring SSL offloading for a reverse proxy web caching configuration using a static
one-to-one firewall virtual IP (VIP). While the static one-to-one configuration described in this example is valid, its
also common to change the destination port of the unencrypted HTTPS traffic to a commonly used HTTP port
such as 8080 using a port forwarding virtual IP.

Network topology and assumptions

In this configuration, clients on the Internet use HTTP and HTTPS to browse to a web server that is behind a
FortiGate unit. A policy added to the FortiGate unit forwards the HTTP traffic to the web server. The policy also
offloads HTTPS decryption and encryption from the web server so the web server only sees HTTP traffic.

The FortiGate unit also caches HTTP and HTTPS pages from the web server so when users access cached pages
the web server does not see the traffic. Replies to HTTPS sessions are encrypted by the FortiGate unit before
returning to the clients.

In this configuration, the FortiGate unit is operating as a web cache in reverse proxy mode. Reverse proxy caches
can be placed directly in front of a web server. Web caching on the FortiGate unit reduces the number of requests
that the web server must handle, therefore leaving it free to process new requests that it has not serviced before.

Using a reverse proxy configuration:

l avoids the capital expense of additional web servers by increasing the capacity of existing servers
l serves more requests for static content from web servers
l serves more requests for dynamic content from web servers
l reduces operating expenses including the cost of bandwidth required to serve content
l accelerates the response time of web servers and of page download times to end users.

When planning a reverse proxy implementation, the web server's content should be written so that it is “cache
aware” to take full advantage of the reverse proxy cache.

In reverse proxy mode, the FortiGate unit functions more like a web server for clients on the Internet. Replicated
content is delivered from the proxy cache to the external client without exposing the web server or the private
network residing safely behind the firewall.

In this example, the site URL translates to IP address 192.168.10.1, which is the port2 IP address of the
FortiGate unit. The port2 interface is connected to the Internet.

This example assumes that all HTTP traffic uses port 80 and all HTTPS traffic uses port 443.

The FortiGate unit includes the web server CA and an SSL server configuration for IP address 172.10.20.30 and
port to 443. The name of the file containing the CA is Rev_Proxy_Cert_1.crt.

The destination address of incoming HTTP and HTTPS sessions is translated to the IP address of the web server
using a static one-to-one virtual IP that performs destination address translation (DNAT) for the HTTP packets.
The DNAT translates the destination address of the packets from 192.168.10.1 to 172.10.20.30 but does not
change the destination port number.

When the SSL server on the FortiGate unit decrypts the HTTPS packets their destination port is changed to port
80.
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Reverse proxy web caching and SSL offloading for an Internet web server
using static one-to-one virtual IPs

General configuration steps

This section breaks down the configuration for this example into smaller procedures. For best results, follow the
procedures in the order given:

1. Configure the FortiGate unit as a reverse proxy web cache server.
2. Configure the FortiGate unit for SSL offloading of HTTPS traffic.
3. Add an SSL server to offload SSL encryption and decryption for the web server.
Also note that if you perform any additional actions between procedures, your configuration may have different
results.

Configuration steps - web-based manager

To configure the FortiGate unit as a reverse proxy web cache server

1. Go to Policy & Objects > Virtual IPsand select Create New to add a static NAT virtual IP that translates
destination IP addresses from 192.168.10.1 to 172.10.20.30 (and does not translate destination ports):

VIP Type IPv4

Name Reverse_proxy_VIP

Interface port2

Type Static NAT

Optional Filters Do not select.

External IP Address/Range 192.168.10.1

Mapped IP Address/Range 172.10.20.30

Port Forwarding Do not select.

2. Select OK.
3. Go to Policy & Objects > IPv4 Policy and select Create New to add a port2 to port1 security policy that

accepts HTTP and HTTPS traffic from the Internet.

Do not select security profiles. Set the destination address to the virtual IP. You do not have to enable NAT.

Incoming Interface port2

Outgoing Interface port1

Source all

Destination Reverse_proxy_VIP
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Schedule always

Service HTTP
HTTPS

Action ACCEPT

4. Turn onWeb Cache.
5. Select OK.
6. From the CLI enter the following command to add HTTPSweb caching to the security policy

Assume the index number of the policy is 5.
config firewall policy

edit 5
set webcache-https ssl-server

end

To configure the FortiGate unit to offload SSL encryption and cache HTTPS content

1. Go to System > Certificates and select Import to import the web server’s CA.

For Type, select Local Certificate. Select the Browse button to locate the file (example file name: Rev_Proxy_
Cert_1.crt).

The certificate key size must be 1024 or 2048 bits. 4096-bit keys are not supported.
2. Select OK to import the certificate.
3. From the CLI, enter the following command to add the SSL server and to add the server’s certificate to the SSL

server.

The SSL server ip must match the destination address of the SSL traffic after being translated by the virtual IP
(172.10.20.30) and the SSL server port must match the destination port of the SSL traffic (443). The SSL server
operates in half mode since it performs a single-step conversion (HTTPS to HTTP or HTTP to HTTPS).

config firewall ssl-server
edit rev_proxy_server

set ip 172.10.20.30
set port 443
set ssl-mode half
set ssl-cert Rev_Proxy_Cert_1

end

Configuration steps - CLI

To configure the FortiGate unit as a reverse proxy web cache server

1. Enter the following command to add a static NAT virtual IP that translates destination IP addresses from
192.168.10.1 to 172.10.20.30 (and does not translate destination ports):

config firewall vip
edit Reverse_proxy_VIP

set extintf port2
set type static-nat
set extip 192.168.10.1
set mappedip 172.10.20.30
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end

2. Enter the following command to add a port2 to port1 security policy that accepts HTTP and HTTPS traffic from the
Internet. Enable web caching and HTTPSweb caching.

Do not select security profiles. Set the destination address to the virtual IP. You do not have to enable NAT.
config firewall policy

edit 0
set srcintf port2
set srcaddr all
set dstintf port1
set dstaddr Reverse_proxy_VIP
set schedule always
set service HTTP HTTPS
set action accept
set webcache enable
set webcache-https ssl-server

end

To add an SSL server to offload SSL encryption and decryption for the web server

1. Place a copy of the web server’s CA (file name Rev_Proxy_Cert_1.crt) in the root folder of a TFTP server.
2. Enter the following command to import the web server’s CA from a TFTP server. The IP address of the TFTP

server is 10.31.101.30:
execute vpn certificate local import tftp Rev_Proxy_Cert_1.crt 10.31.101.30

The certificate key size must be 1024 or 2048 bits. 4096-bit keys are not supported.

3. From the CLI, enter the following command to add the SSL server.

The SSL server ip must match the destination address of the SSL traffic after being translated by the virtual IP
(172.10.20.30) and the SSL server port must match the destination port of the SSL traffic (443). The SSL server
operates in half mode since it performs a single-step conversion (HTTPS to HTTP or HTTP to HTTPS).

config firewall ssl-server
edit rev_proxy_server

set ip 172.10.20.30
set port 443
set ssl-mode half
set ssl-cert Rev_Proxy_Cert_1

end

4. Configure other ssl-server settings that you may require for your configuration.

Using a FortiCache as a cache service
Some FortiGate devices don't have sufficient memory or disk space to run a cache service. This feature allows a
FortiGate to connect to a FortiCache that has a higher cache capability than most FortiGates.

Syntax:

config wanopt remote-storage
set status {enable|disable}
set local-cache-id <name ID for connection>
set remote-cache-id <ID of the remote device>
set remote-cache-ip <IP address of the remote device>
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end

Option Description

status Enable or disable whether the FortiGate uses a remote caching device as web-cache
storage. If disabled, uses local disk(s) as web storage.

local-
cache-id ID that this device uses to connect to the remote caching device

remote-
cache-id

ID of the remote caching device that this FortiGate connects to

remote-
cache-ip IP address of the remote caching device that this FortiGate connects to.

WCCP Concepts

The Web Cache Communication Protocol (WCCP) can be used to provide web caching with load balancing and
fault tolerance. In a WCCP configuration, a WCCP server receives HTTP requests from user’s web browsers and
redirects the requests to one or more WCCP clients. The clients either return cached content or request new
content from the destination web servers before caching it and returning it to the server which in turn returns the
content to the original requestor. If a WCCP configuration includes multiple WCCP clients, the WCCP server load
balances traffic among the clients and can detect when a client fails and failover sessions to still operating clients.
WCCP is described by the Web Cache Communication Protocol Internet draft.

The sessions that are cached byWCCP depend on the configuration of the WCCP clients. If the client is a
FortiGate unit, you can configure the port numbers and protocol number of the sessions to be cached. For
example, to cache HTTPS traffic on port 443 the WCCP client port must be set to 443 and protocol must be set to
6. If the WCCP client should also cache HTTPS traffic on port 993 the client ports option should include both port
443 and 993.

On a FortiGate unit, WCCP sessions are accepted by a security policy before being cached. If the security policy
that accepts sessions that do not match the port and protocol settings in the WCCP clients the traffic is dropped.

WCCP is configured per-VDOM. A single VDOM can operate as a WCCP server or client (not both at the same
time). FortiGate units are compatible with third-party WCCP clients and servers. If a FortiGate unit is operating
as an Internet firewall for a private network, you can configure it to cache and serve some or all of the web traffic
on the private network using WCCP by adding one or more WCCP clients, configuring WCCP server settings on
the FortiGate unit and adding WCCP security policies that accept HTTP session from the private network.

FortiGate units support WCCPv1 and WCCPv2. A FortiGate unit in NAT or transparent mode can operate as a
WCCP server. To operate as a WCCP client a FortiGate unit must be in NAT mode. FortiGate units communicate
between WCCP servers and clients over UDP port 2048. This communication can be encapsulated in a GRE
tunnel or just use layer 2 forwarding.

AWCCP server can also be called a WCCP router. AWCCP client can also be called a
WCCP cache engine.
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WCCP Configuration

WCCP configuration overview
To configure WCCP you must create a service group that includesWCCP servers and clients. WCCP servers
intercept sessions to be cached (for example, sessions from users browsing the web from a private network). To
intercept sessions to be cached the WCCP server must include a security policy that accepts sessions to be
cached and WCCPmust be enabled in this security policy.

The server must have an interface configured for WCCP communication with WCCP clients. That interface sends
and receives encapsulated GRE traffic to and from WCCP clients. The server must also include a WCCP service
group that includes a service ID and the addresses of the WCCP clients as well as other WCCP configuration
options.

To use a FortiGate unit as a WCCP client, the FortiGate unit must be set to be a WCCP client (or cache engine).
You must also configure an interface on the client for WCCP communication. The client sends and receives
encapsulated GRE traffic to and from the WCCP server using this interface.

The client must also include a WCCP service group with a service ID that matches a service ID on the server. The
client service group also includes the IP address of the servers in the service group and specifies the port numbers
and protocol number of the sessions that will be cached on the client.

When the client receives sessions from the server on its WCCP interface, it either returns cached content over the
WCCP interface or connects to the destination web servers using the appropriate interface depending on the
client routing configuration. Content received from web servers is then cached by the client and returned to the
WCCP server over the WCCP link. The server then returns the received content to the initial requesting user web
browser.

Finally you may also need to configure routing on the server and client FortiGate units and additional security
policies may have to be added to the server to accept sessions not cached byWCCP.

WCCP service groups, service numbers, service IDs and well known services
A FortiGate unit configured as a WCCP server or client can include multiple server or client configurations. Each
of these configurations is called a WCCP service group. A service group consists of one or more WCCP servers
(or routers) and one or more WCCP clients working together to cache a specific type of traffic. The service group
configuration includes information about the type of traffic to be cached, the addresses of the WCCP clients and
servers and other information about the service.

A service group is identified with a numeric WCCP service ID (or service number) in the range 0 to 255. All of the
servers and clients in the sameWCCP service group must have service group configurations with the same
WCCP service ID.

The value of the service ID provides some information about the type of traffic to be cached by the service group.
Service IDs in the range 0 to 50 are reserved for well known services. A well known service is any service that is
defined by the WCCP standard as being well known. Since the service is well known, just the service ID is
required to identify the traffic to be cached.

Even though the well known service ID range is 0 to 50, at this time only one well known service has been
defined. Its service ID 0, which is used for caching HTTP (web) traffic.
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So to configure WCCP to cache HTTP sessions you can add a service group to the WCCP router and WCCP
clients with a service ID of 0. No other information about the type of traffic to cache needs to be added to the
service group.

Since service IDs 1 to 50 are reserved for well know services and since these services are not defined yet, you
should not add service groups with IDs in the range 1 to 50.

FortiOS does allow you to add service groups with IDs between 1 and 50. Since these
service groups have not been assigned well known services, however, they will not
cache any sessions. Service groups with IDs 51 to 255 allow you to set the port
numbers and protocol number of the traffic to be cached. So you can use service
groups with IDs 51 to 255 to cache different kinds of traffic based on port numbers and
protocol number of the traffic. Service groups 1 to 50; however, do not allow you to set
port numbers or protocol numbers so cannot be used to cache any traffic.

To cache traffic other than HTTP traffic you must add service groups with IDs in the range 51 to 255. These
service group configurations must include the port numbers and protocol number of the traffic to be cached. It is
the port and protocol number configuration in the service group that determines what traffic will be cached by
WCCP.

Example WCCP server and client configuration for caching HTTP sessions (service ID = 0)

Enter the following command to add a WCCP service group to a WCCP server that caches HTTP sessions. The
IP address of the server is 10.31.101.100 and the WCCP clients are on the 10.31.101.0 subnet. The service

ID of this service group is 0.

config system wccp
edit 0

set router-id 10.31.101.100
set server-list 10.31.101.0 255.255.255.0

end

Enter the following commands to configure a FortiGate unit to operate as a WCCP client and add a service group
that configures the client to cache HTTP sessions. The IP address of the server is 10.31.101.100 and IP address
of this WCCP clients is 10.31.101.1 subnet. The service ID of this service group is 0.

config system settings
set wccp-cache-engine enable

end

config system wccp
edit 0

set cache-id 10.31.101.1
set router-list 10.31.101.100

end

You cannot enter the wccp-cache-engine enable command if you have already
added a WCCP service group. When you enter this command an interface named
w.<vdom_name> is added to the FortiGate configuration (for example w.root). All
traffic redirected from a WCCP router is considered to be received at this interface of
the FortiGate unit operating as a WCCP client. A default route to this interface with
lowest priority is added.
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Example WCCP server and client configuration for caching HTTPS sessions

Enter the following command to add a service group to a WCCP server that caches HTTPS content on port 443
and protocol 6. The IP address of the server is 10.31.101.100 and the WCCP clients are on the 10.31.101.0
subnet. The service ID of this service group is 80.

config system settings
set wccp-cache-engine enable

end

config system wccp
edit 80

set router-id 10.31.101.100
set server-list 10.31.101.0 255.255.255.0
set ports 443
set protocol 6

end

Enter the following commands to configure a FortiGate unit to operate as a WCCP client and add a service group
that configures client to cache HTTPS sessions on port 443 and protocol 6. The IP address of the server is
10.31.101.100 and IP address of this WCCP clients is 10.31.101.1 subnet. The service ID of this service group
must be 80 to match the service ID added to the server.

config system settings
set wccp-cache-engine enable

end

config system wccp
edit 80

set cache-id 10.31.101.1
set router-list 10.31.101.100
set ports 443
set protocol 6

end

Example WCCP server and client configuration for caching HTTP and HTTPS sessions

You could do this by configuring two WCCP service groups as described in the previous examples. Or you could
use the following commands to configure one service group for both types of traffic. The example also caches
HTTP sessions on port 8080.

Enter the following command to add a service group to a WCCP server that caches HTTP sessions on ports 80
and 8080 and HTTPS sessions on port 443. Both of these protocols use protocol number 6. The IP address of the
server is 10.31.101.100 and the WCCP clients are on the 10.31.101.0 subnet. The service ID of this service group
is 90.

config system wccp
edit 90

set router-id 10.31.101.100
set server-list 10.31.101.0 255.255.255.0
set ports 443 80 8080
set protocol 6

end

Enter the following commands to configure a FortiGate unit to operate as a WCCP client and add a service group
that configures client to cache HTTP sessions on port 80 and 8080 and HTTPS sessions on port 443. The IP
address of the server is 10.31.101.100 and IP address of this WCCP clients is 10.31.101.1 subnet. The service ID
of this service group must be 90 to match the service ID added to the server.
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config system settings
set wccp-cache-engine enable

end
config system wccp

edit 90
set cache-id 10.31.101.1
set router-list 10.31.101.100
set ports 443 80 8080
set protocol 6

end

Other WCCP service group options

In addition to using WCCP service groups to define the types of traffic to be cached byWCCP the following
options are available for servers and clients.

Server configuration options

The server configuration must include the router-id, which is the WCCP server IP address. This is the IP
address of the interface that the server uses to communicate with WCCP clients.

The group-address is used for multicast WCCP configurations to specify the multicast addresses of the
clients.

The server-list defines the IP addresses of the WCCP clients that the server can connect to. Often the
server list can be the address of the subnet that contains the WCCP clients.

The authentication option enables or disables authentication for the WCCP service group. Authentication
must be enabled on all servers and clients in a service group and members of the group must have the same
password.

The forward-method option specifies the protocol used for communication between the server and clients.
The default forwarding method is GRE encapsulation. If required by your network you can also select to use
unencapsulated layer-2 packets instead of GRE or select any to allow both. The return-method allows you to
specify the communication method from the client to the server. Both GRE and layer-2 are supported.

The assignment-method determines how the server load balances sessions to the clients if there are multiple
clients. Load balancing can be done using hashing or masking.

Client configuration options

The client configuration includes the cache-id which is the IP address of the FortiGate interface of the client
that communicates with WCCP server. The router-list option is the list of IP addresses of the WCCP
servers in the WCCP service group.

The ports option lists the port numbers of the sessions to be cached by the client and the protocol sets the
protocol number of the sessions to be cached. For TCP sessions the protocol is 6.

The service-type option can be auto, dynamic or standard. Usually you would not change this setting.

The client configuration also includes options to influence load balancing including the primary-hash,
priority, assignment-weight and assignment-bucket-format.
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Example caching HTTP sessions on port 80 using WCCP
In this example configuration (shown below), a FortiGate unit with host nameWCCP_srv is operating as an
Internet firewall for a private network is also configured as a WCCP server. The port1 interface of WCCP_srv is
connected to the Internet and the port2 interface is connected to the internal network.

All HTTP traffic on port 80 that is received at the port2 interface of WCCP_srv is accepted by a port2 to port1
security policy with WCCP enabled. All other traffic received at the port2 interface is allowed to connect to the
Internet by adding a general port2 to port1 security policy below the HTTP on port 80 security policy.

AWCCP service group is added to WCCP_srv with a service ID of 0 for caching HTTP traffic on port 80. The port5
interface of WCCP_srv is configured for WCCP communication.

A second FortiGate unit with host nameWCCP_client is operating as a WCCP client. The port1 interface of
WCCP_client is connected to port5 of WCCP_srv and is configured for WCCP communication.

WCCP_client is configured to cache HTTP traffic because it also has a WCCP service group with a service ID of
0.

WCCP_client connects to the Internet through WCCP_srv. To allow this, a port5 to port1 security policy is added
to WCCP_srv.

FortiGate WCCP server and client configuration

Configuring the WCCP server (WCCP_srv)

Use the following steps to configure WCCP_srv as the WCCP server for the example network. The example steps
only describe the WCCP-related configuration.

To configure WCCP_srv as a WCCP server

1. Add a port2 to port1 security policy that accepts HTTP traffic on port 80 and is configured for WCCP:
config firewall policy

edit 0
set srtintf port2
set dstintf port1
set srcaddr all
set dstaddr all
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set action accept
set schedule always
set service HTTP
set wccp enable
set nat enable

end

2. Add another port2 to port1 security policy to allow all other traffic to connect to the Internet.
config firewall policy

edit 0
set srtintf port2
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL
set nat enable

end

3. Move this policy below the WCCP policy in the port2 to port1 policy list.
4. Enable WCCP on the port5 interface.

config system interface
edit port5

set wccp enable
end

5. Add a WCCP service group with service ID 0.
config system wccp

edit 0
set router-id 10.51.101.100
set server-list 10.51.101.0 255.255.255.0

end

6. Add a firewall address and security policy to allow the WCCP_client to connect to the internet.
config firewall address

edit WCCP_client_addr
set subnet 10.51.101.10

end
config firewall policy

edit 0
set srtintf port5
set dstintf port1
set srcaddr WCCP_client_addr
set dstaddr all
set action accept
set schedule always
set service ALL
set nat enable

end

Configuring the WCCP client (WCCP_client)

Use the following steps to configure WCCP_client as the WCCP client for the example network. The example
steps only describe the WCCP-related configuration.
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To configure WCCP_client as a WCCP client

1. Configure WCCP_client to operate as a WCCP client.
config system settings

set wccp-cache-engine enable
end

You cannot enter the wccp-cache-engine enable command if you have already
added a WCCP service group. When you enter this command an interface named
w.<vdom_name> is added to the FortiGate configuration (for example w.root). All
traffic redirected from a WCCP router is considered to be received at this interface of
the FortiGate unit operating as a WCCP client. A default route to this interface with
lowest priority is added.

2. Enable WCCP on the port1 interface.
config system interface

edit port1
set wccp enable

end

3. Add a WCCP service group with service ID 0.
config system wccp

edit 0
set cache-id 10.51.101.10
set router-list 10.51.101.100

end

Example caching HTTP sessions on port 80 and HTTPS sessions on port 443 using
WCCP

This example configuration is the same as that described in Example caching HTTP sessions on port 80 and
HTTPS sessions on port 443 using WCCP on page 1182 except that WCCP now also cached HTTPS traffic on
port 443. To cache HTTP and HTTPS traffic the WCCP service group must have a service ID in the range 51 to
255 and you must specify port 80 and 443 and protocol 6 in the service group configuration of the WCCP client.

Also the security policy on the WCCP_srv that accepts sessions from the internal network to be cached must
accept HTTP and HTTPS sessions.
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FortiGate WCCP server and client configuration

Configuring the WCCP server (WCCP_srv)

Use the following steps to configure WCCP_srv as the WCCP server for the example network. The example steps
only describe the WCCP-related configuration.

To configure WCCP_srv as a WCCP server

1. Add a port2 to port1 security policy that accepts HTTP traffic on port 80 and HTTPS traffic on port 443 and is
configured for WCCP:

config firewall policy
edit 0

set srtintf port2
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service HTTP HTTPS
set wccp enable
set nat enable

end

2. Add another port2 to port1 security policy to allow all other traffic to connect to the Internet.
config firewall policy

edit 0
set srtintf port2
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

set nat enable
end
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3. Move this policy below the WCCP policy in the port2 to port1 policy list.
4. Enable WCCP on the port5 interface.

config system interface
edit port5

set wccp enable
end

5. Add a WCCP service group with service ID 90 (can be any number between 51 and 255).
config system wccp

edit 90
set router-id 10.51.101.100
set server-list 10.51.101.0 255.255.255.0

end

6. Add a firewall address and security policy to allow the WCCP_client to connect to the internet.
config firewall address

edit WCCP_client_addr
set subnet 10.51.101.10

end
config firewall policy

edit 0
set srtintf port5
set dstintf port1
set srcaddr WCCP_client_addr
set dstaddr all
set action accept
set schedule always
set service ALL
set nat enable

end

Configuring the WCCP client (WCCP_client)

Use the following steps to configure WCCP_client as the WCCP client for the example network. The example
steps only describe the WCCP-related configuration.

To configure WCCP_client as a WCCP client

1. Configure WCCP_client to operate as a WCCP client.
config system settings

set wccp-cache-engine enable
end

You cannot enter the wccp-cache-engine enable command if you have already
added a WCCP service group. When you enter this command an interface named
w.<vdom_name> is added to the FortiGate configuration (for example w.root). All
traffic redirected from a WCCP router is considered to be received at this interface of
the FortiGate unit operating as a WCCP client. A default route to this interface with
lowest priority is added.

2. Enable WCCP on the port1 interface.
config system interface

edit port1
set wccp enable
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end

3. Add a WCCP service group with service ID 90. This service group also specifies to cache sessions on ports 80 and
443 (for HTTP and HTTPS) and protocol number 6.

config system wccp
edit 90

set cache-id 10.51.101.10
set router-list 10.51.101.100
ports 80 443
set protocol 6

end

WCCP packet flow
The following packet flow sequence assumes you have configured a FortiGate unit to be a WCCP server and one
or more FortiGate units to be WCCP clients.

1. A user’s web browser sends a request for web content.
2. The FortiGate unit configured as a WCCP server includes a security policy that intercepts the request and

forwards it to a WCCP client.

The security policy can apply UTM features to traffic accepted by the policy.
3. The WCCP client receives the WCCP session.
4. The client either returns requested content to the WCCP server if it is already cached, or connects to the

destination web server, receives and caches the content and then returns it to the WCCP server.
5. The WCCP server returns the requested content to the user’s web browser.
6. The WCCP router returns the request to the client web browser.

The client we browser is not aware that all this is taking place and does not have to be configured to use a web
proxy.

Configuring the forward and return methods and adding authentication
The WCCP forwarding method determines how intercepted traffic is transmitted from the WCCP router to the
WCCP cache engine. There are two different forwarding methods:

l GRE forwarding (the default) encapsulates the intercepted packet in an IP GRE header with a source IP address of
the WCCP router and a destination IP address of the target WCCP cache engine. The results is a tunnel that allows
the WCCP router to be multiple hops away from the WCCP cache server.

l L2 forwarding rewrites the destination MAC address of the intercepted packet to match the MAC address of the
target WCCP cache engine. L2 forwarding requires that the WCCP router is Layer 2 adjacent to the WCCP client.

You can use the following command on a FortiGate unit configured as a WCCP router to change the forward and
return methods to L2:

config system wccp
edit 1

set forward-method L2
set return-method L2

end

You can also set the forward and return methods to any in order to match the cache server configuration.
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By default the WCCP communication between the router and cache servers is unencrypted. If you are concerned
about attackers sniffing the information in the WCCP stream you can use the following command to enable hash-
based authentication of the WCCP traffic. You must enable authentication on the router and the cache engines
and all must have the same password.

config system wccp
edit 1

set authentication enable
set password <password>

end

WCCP Messages
When the WCCP service is active on a web cache server it periodically sends a WCCPHERE I AM broadcast or
unicast message to the FortiGate unit operating as a WCCP router. This message contains the following
information:

l Web cache identity (the IP address of the web cache server).
l Service info (the service group to join).

If the information received in the previous message matches what is expected, the FortiGate unit replies with a
WCCP I SEE YOUmessage that contains the following details:

l Router identity (the FortiGate unit’s IP address.
l Sent to IP (the web cache IP addresses to which the packets are addressed)

When both ends receive these two messages the connection is established, the service group is formed and the
designated web cache is elected.

Troubleshooting WCCP
Two types of debug commands are available for debugging or troubleshooting a WCCP connection between a
FortiGate unit operating as a WCCP router and its WCCP cache engines.

Real time debugging

The following commands can capture live WCCPmessages:

diag debug en
diag debug application wccpd <debug level>

Application debugging

The following commands display information about WCCP operations:

get test wccpd <integer>
diag test application wccpd <integer>

Where <integer> is a value between 1 and 6:

1. DisplayWCCP stats
2. DisplayWCCP config
3. DisplayWCCP cache servers
4. DisplayWCCP services
5. DisplayWCCP assignment
6. DisplayWCCP cache status
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Enter the following command to view debugging output:

diag test application wccpd 3

Sample output from a successful WCCP connection:

service-0 in vdom-root: num=1, usable=1
cache server ID:
len=44, addr=172.16.78.8, weight=4135, status=0
rcv_id=6547, usable=1, fm=1, nq=0, dev=3(k3),
to=192.168.11.55
ch_no=0, num_router=1:
192.168.11.55

Sample output from the same command from an unsuccessful WCCP connection (because of a service group
password mismatch):

service-0 in vdom-root: num=0, usable=0
diag debug application wccpd -1
Sample output:
wccp_on_recv()-98: vdom-root recv: num=160, dev=3(3),
172.16.78.8->192.168.11.55
wccp2_receive_pkt()-1124: len=160, type=10, ver=0200,
length=152
wccp2_receive_pkt()-1150: found component:t=0, len=20
wccp2_receive_pkt()-1150: found component:t=1, len=24
wccp2_receive_pkt()-1150: found component:t=3, len=44
wccp2_receive_pkt()-1150: found component:t=5, len=20
wccp2_receive_pkt()-1150: found component:t=8, len=24
wccp2_check_security_info()-326: MD5 check failed

Web Proxy Concepts

These are concepts that apply to both Transparent and Explicit Proxy.

Proxy Policy
Information on Proxy policy options can be found at Proxy Option Components on page 964

Configuration information can be found at Web Proxy Configuration on page 1194

Proxy Authentication
Beginning in FortiOS 5.6, authentication is separated from authorization for user based policy. You can add
authentication to proxy policies to control access to the policy and to identify users and apply different UTM
features to different users. The described authenication methodology works with Explicit Web Proxy and
Transparent Proxy.

Authentication of web proxy sessions uses HTTP basic and digest authentication as described in RFC 2617
(HTTP Authentication: Basic and Digest Access Authentication) and prompts the user for credentials from the
browser allowing individual users to be identified by their web browser instead of IP address. HTTP authentication
allows the FortiGate unit to distinguish between multiple users accessing services from a shared IP address.

The methodology of adding authentication has changed from FortiOS version 5.4 and previous version. Split-
policy has been obsoleted and instead of identity-based-policy, authentication is managed by
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authentication scheme, setting and rule settings. These authentication settings are no longer
configured with the individual policies. Authentication is set up in the contexts of:

config authentication scheme
config authentication setting
config authentication rule

The Authentication rule table defines how to identify user-ID. It uses the match factors:

l Protocol
l Source Address

For one address and protocol, there is only one authentication rule. It is possible to configure multiple
authentication methods for on one address. The client browser will chose one authentication method from the
authentication methods list, but you can not control which authentication method will be chosen by the browser.

Matching

If a rule is matched, the authentication methods defined in the rule will be used to authenticate a user. The
procedure works as the following:

1. If it is IP-based, look up active user list to see a user existed from the source IP. If found, return the user ID.
2. If no method is set, an anonymous user is created to associate to the source-IP. Return the anonymous user. It is

another way to bypass user authentication for some source IPs.
3. Use authentication methods to authenticate the user.

l If no active method is defined, a failure will result to return an anonymous user.
l Otherwise, a valid or guest user has to be identified to move on.
l Return the identified user ID.

Once a user is returned, the policy match resumes until a policy is matched or default policy will be used.

Processing policies for Authentication

Authentication rules are checked once a User-ID is needed in order to resolve a match to a policy

Use the following scenario as an example of the process.

There are 3 policies:

l policy1 does not have an associated user group
l policy2 has an associated user group
l policy3 does not have an associated user group

Step 1

If the traffic, based on protocol and source address matchespolicy 1, no user authentication is needed. The
traffic is processed by policy1.

Step 2

If the traffic does not match policy 1, and any factor of policy 2 is not matched, continue to next policy.

If all the factors except the user-group of policy 2 are matched the authentication rule table is checked to get
user-ID in the process in based on the procedure described earlier in Matching.
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Step 3

When a user-ID is returned, whether it is a valid user or anonymous user, it is checked to see if the user is
authorized by the user group associated with policy2. If yes, it is a match of policy2, and the traffic is
processed by policy2. If not move on the next policy.

Step 4

For the purposes of the scenario, it will be assumed that the traffic either matches policy3 or that policy3 is
the final policy that denies everything.

CLI Syntax

Removals:

l "split-policy" from firewall explicit-proxy-policy.

The previous method to set up a split policy was:

config firewall explicit-proxy-policy
edit 1

set proxy web
set identity-based enable
set groups <User group>
config identity-based-policy

edit 1
set schedule "always"
set utm-status enable
set users "guest"
set profile-protocol-options "default"
next

end
next

end

l "auth relative" from firewall explicit-proxy-policy

The following attributes have been removed from firewall explicit-proxy-policy:

l identity-based
l ip-based
l active-auth-method
l sso-auth-method
l require-tfa

Moves:

users and groups from

firewall explicit-proxy-policy identity-based-policy

to

config firewall proxy-policy
edit 1
set groups <Group name>
set users <User name>
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end

Additions:

authentication scheme

config authentication scheme
edit <name>

set method [ntlm|basic|digest|form|negotiate|fsso|rsso|none]

l ntlm - NTLM authentication.
l basic - Basic HTTP authentication.
l digest - Digest HTTP authentication.
l form - Form-based HTTP authentication.
l negotiate - Negotiate authentication.
l fsso - FSSO authentication.
l rsso - RADIUS Single Sign-On authentication.
l none - No authentication.

authentication setting

config authentication setting
set active-auth-scheme <string>
set sso-auth-scheme <string>
set captive-portal <string>
set captive-portal-port <integer value from 1 to 65535>

l active-auth-scheme - Active authentication method.
l sso-auth-scheme - SSO authentication method.
l captive-portal - Captive portal host name.
l captive-portal-port - Captive portal port number.

authentication rule

config authentication rule
edit <name of rule>

set status [enable|disable]
set protocol [http|ftp|socks]
set srcaddr <name of address object>
set srcaddr6 <name of address object>
set ip-based [enable|disable]
set active-auth-method <string>
set sso-auth-method <string>
set web-auth-cookie [enable|disable]
set transaction-based [enable|disable]
set comments

l status - Enable/disable auth rule status.
l protocol - set protocols to be matched
l srcaddr /srcaddr6 - Source address name. [srcaddr or srcaddr6(web proxy only) must be set].
l ip-based - Enable/disable IP-based authentication.
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l active-auth-method - Active authentication method.
l sso-auth-method - SSO authentication method (require ip-based enabled)
l web-auth-cookie - Enable/disable Web authentication cookie.
l transaction-based - Enable/disable transaction based authentication.
l comments - Comment.

Configuring Authentication in Transparent Proxy

You can enable transparent web-proxy feature to support authentication. Follow these steps

1. Configure a firewall policy
2. Enable a UTM profile in the firewall policy. Whenever there is a UTM item enabled, the feature enables the

profile-protocol-options.
3. Go to the Proxy Options profile.

l In the GUI this is Security Profiles > Proxy Options.
l In the CLI it is config firewall profile-protocol-options.

Edit the profile used by the policy.

4. Enable HTTP in the profile.
In the GUI toggle on HTTP under Protocol Port Mapping

In the CLI, the command sequence is:

config firewall profile-protocol-options
edit <profile id>

config http
set status enable
end

Fill out any other appropriate values.

5. Configure the proxy-policy, and set the value transparent-web for proxy option, others configuration are same as
the explicit-web proxy

In the GUI, go to Policy & Objects > Proxy Policy. In the Proxy Type field choose Transparent
Web .

In the CLI, the command sequence is:

config firewall proxy-policy
edit <profile id>

set proxy transparent-web
end

Fill out any other appropriate values.

6. Setup the authentication rule and scheme
With this configuration, if a HTTP request passes through FortiGate without explicit web proxy being applied, the
traffic will be redirected to WAD daemon after it matches the proxy with HTTP-policy enabled, then WAD will do
the proxy-policy matching, and all of the proxy authentication method can be used for the request.

Proxy Addresses
Information on Proxy addresses can be found at Proxy Addresses on page 1080
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Proxy Address group

In the same way that IPv4 and IPv6 addresses can only be grouped together, Proxy addresses can only be
grouped with other Proxy addresses. Unlike the other address groups, the Proxy address groups are further
divided into source address groups and destination address groups. To see the configuration steps go to Proxy
Address Groups on page 1082

Web Proxy firewall services and service groups
Configure web proxy services by selecting Explicit Proxywhen configuring a service. Web proxy services can be
selected in a explicit web proxy policy when adding one from the CLI. If you add a policy from the web-based
manager the service is set to thewebproxy service. The webproxy service should be used in most cases, it
matches with any traffic with any port number. However, if you have special requirements, such as using a
custom protocol type or a reduced port range or need to add an IP/FQDN to an proxy service you can create
custom explicit web proxy services.

Web proxy services are similar to standard firewall services. You can configure web proxy services to define one
or more protocols and port numbers that are associated with each web proxy service. Web proxy services can also
be grouped into web proxy service groups.

One way in which web proxy services differ from firewall services is the protocol type you can select. The following
protocol types are available:

l ALL
l CONNECT
l FTP
l HTTP
l SOCKS-TCP
l SOCKS-UDP

To add a web proxy service go to Policy & Objects > Servicesand select Create New. Set Service Type to
Explicit Proxy and configure the service as required.

To add a web proxy service from the CLI enter:

config firewall service custom
edit my-socks-service

set explicit-proxy enable
set category Web Proxy
set protocol SOCKS-TCP
set tcp-portrange 3450-3490

end

To add a web proxy service group go to Policy & Objects > Servicesand select Create New > Service
Group. Set Type to Explicit Proxy and add web proxy services to the group as required.

To add a web proxy service group from the CLI enter:

config firewall service group
edit web-group

set explicit-proxy enable
set member webproxy my-socks-service

end
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Learn client IP
If there is another NATing device between the FortiGate and the Client (browser), this feature can be used to
identify the real client in spite of the address translation. Knowing the actual client is imperative in cases where
authorization is taking place.

The settings for the feature are in the CLI in the context of

config web-proxy global

Once here, enable the feature with the command:

set learn-client-ip enable

Once the feature is enabled, the other settings become available.

learn-client-ip-from-header

This command has the following options:

true-client-ip Support HTTP header True-Client-IP.

x-real-ip Support HTTP header X-Real-IP.

x-forwarded-for Support HTTP header X-Forwarded-For.

learn-client-ip-srcaddr/learn-client-ip-srcaddr6

The options for this setting are selected from the list of IPv4 address or IPv6 address objects.

Example

Below is a config example where the real client ip address will be used to match policy or fsso authentication after
the learn-client-ip feature enabled.

The value of learn-client-ip-from-header option can be set to true-client-ip, x-real-ip or
x-forwarded-for, but in this case it has been set to x-forward-for.

config web-proxy global
set proxy-fqdn "default.fqdn"
set webproxy-profile "default"
set learn-client-ip enable
set learn-client-ip-from-header x-forwarded-for
set learn-client-ip-srcaddr "all"
end

config firewall proxy-policy
edit 1

set proxy explicit-web
set dstintf "mgmt1"
set srcaddr "all"
set dstaddr "all"
set service "w"
set action accept
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set schedule "always"
set groups "fsso1"
set utm-status enable
set av-profile "default"
set dlp-sensor "default"
set profile-protocol-options "default"
set ssl-ssh-profile "deep-inspection"
end

config authentication rule
edit "rule1"

set srcaddr "all"
set sso-auth-method "scheme1"
end

config authentication scheme
edit "scheme1"

set method fsso
end

Web Proxy Configuration

General web proxy configuration steps
You can use the following general steps to configure the explicit web proxy.

To enable the explicit web proxy - web-based manager:

1. Go to Network > Explicit Proxy and enable Explicit Web Proxy. From here you can optionally change the
HTTP port that the proxy listens on (the default is 8080) and optionally specify different ports for HTTPS, FTP,
PAC, and other options.

2. Optionally enable IPv6 Explicit Proxy to turn on the explicit web proxy for IPv6 traffic.

If you enable both the IPv4 and the IPv6 explicit web proxy you can combine IPv4 and
IPv6 addresses in a single explicit web proxy policy to allow both IPv4 and IPv6 traffic
through the proxy.

3. Select Apply.

4. Go to Network > Interfaces and select one or more interfaces for which to enable the explicit web proxy. Edit the
interface. Under theMiscellaneous heading select Enable Explicit Web Proxy.

Enabling the explicit web proxy on an interface connected to the Internet is a security
risk because anyone on the Internet who finds the proxy could use it to hide their
source address. If you enable the proxy on such an interface make sure authentication
is required to use the proxy.

5. Go to Policy & Objects > Addresses and select Create New to add a firewall address that matches the source
address of packets to be accepted by the explicit proxy.
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Category Address

Name Internal_subnet

Type IP Range

Subnet / IP Range 10.31.101.1 - 10.31.101.255

Interface any*

*The Interfacemust be set to Any.

You can also set the Type to URL Pattern (Explicit Proxy) to add a destination URL that is only
used by the explicit proxy. For example, to create an explicit policy that only allows access to
Fortinet.com:

Category Address

Name Fortinet-web-sites

Type URL Pattern (Explicit Proxy)

URL Pattern fortinet.com

Interface any

6. Go to Policy & Objects > Proxy Policyand select Create New. Configure the policy as required to accept the
traffic that you want to be allowed to use the explicit web proxy.

7. Set theOutgoing Interface parameter by selecting the field with the "+" next to the field label. Selecting the field
will slide out a window from the right where you can select from the available interfaces. You can select one or
more specific interfaces For more information on interfaces, check the Concepts section called Interfaces and
Zones.

8. The Source of the policy must match the client’s source IP addresses. The interface of this firewall address must
be set to any.

9. The Destination field should match the addresses of web sites that clients are connecting to. Usually the
destination address would be all if proxying Internet web browsing. You could also specify a URL firewall address
to limit the policy to allowing access to this URL.

10. Set the Schedule parameter by using the drop down menu to select a preconfigured schedule. The "+" icon next
to the Search field is a shortcut for creating a new schedule object. For more information on addresses, check the
Firewall Objects section called Firewall schedules

11. If Default Firewall Policy Action is set to Deny (underNetwork > Explicit Proxy), traffic sent to the explicit
web proxy that is not accepted by a web-proxy policy is dropped. If Default Firewall Policy Action is set to
Allow then all web-proxy sessions that don’t match with a security policy are allowed.

For example, the following security policy allows users on an internal network to access fortinet.com websites
through the wan1 interface of a FortiGate unit.

Explicit Proxy Type Web

Source Address Internal_subnet
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Outgoing Interface wan1

Destination Address Fortinet-web-sites

Schedule always

Action ACCEPT

The explicit web-proxy accepts VIP addresses for destination addresses. If an external
IP matches a VIP policy, the IP is changed to the mapped-IP of the VIP.

12. Set the Disclaimer Options
You can configure a disclaimer for each Authentication Rule by enabling one of the options here. The
choices are:

Disable No disclaimer (default setting)

By Domain The disclaimer will be displayed on different domains. The explicit web
proxy will check the referring header to mitigate the
javascript/css/images/video/etc page.

By Policy The disclaimer will be displayed if the HTTP request matches a different
explicit firewall policy.

By User The disclaimer will be displayed when a new user logs on.

If you chose a disclaimer option other than Disable, you will have the option to enable Customize
Messages. If enabled, select the Edit Disclaimer Message button to customize the message to your
needs. This can be done as text or as HTML. The default HTML version is there if you just want to make minor
changes.

13. Enable Security Profiles as required. Once the profile type is toggled to enabled, you can use the drop down
menu to select a specific profile. The available profile types are:
l AntiVirus
l WebFilter
l Application Control
l IPS
l DLP Sensor
l ICAP
l Web Application Firewall

Just like with a regular policy, as soon as any of the Security Profiles is enabled, the following fields,
with their own drop down menus for specific profiles will appear:

l Proxy Options
l SSL/SSH Inspection

14. Select OK.
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To enable the explicit web proxy - CLI:

1. Enter the following command to turn on the IPv4 and IPv6 explicit web proxy for HTTP and HTTPS traffic.
config web-proxy explicit

set status enable
set ipv6-status enable

end

You can also enter the following command to enable the web proxy for FTP sessions in a web
browser.

config web-proxy explicit
set ftp-over-http enable

end

The default explicit web proxy configuration has sec-default-action set to deny and requires
you to add a security policy to allow access to the explicit web proxy.

2. Enter the following command to enable the explicit web proxy for the internal interface.
config system interface

edit internal
set explicit-web-proxy enable

end
end

3. Use the following command to add a firewall address that matches the source address of users who connect to the
explicit web proxy.

config firewall address
edit Internal_subnet

set type iprange
set start-ip 10.31.101.1
set end-ip 10.31.101.255

end

The source address for a web-proxy security policy cannot be assigned to a FortiGate interface.

4. Optionally use the following command to add a destination URL that is only used by the explicit proxy. For
example, to create an explicit policy that only allows access to Fortinet.com:

config firewall address
edit Fortinet-web-sites

set type url
set url fortinet.com

end

5. Use the following command to add an explicit web proxy policy that allows all users on the internal subnet to use
the explicit web proxy for connections through the wan1 interface to the Internet.

config firewall proxy-policy
edit 0

set proxy explicit-web
set dstintf wan1
set scraddr Internal_subnet
set dstaddr all
set action accept
set service webproxy
set schedule always
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end

6. Use the following command to add an explicit web proxy policy that allows authenticated users on the internal
subnet to use the explicit web proxy for connections through the wan1 interface to the Internet.

config firewall proxy-policy
edit 0

set proxy explicit-web
set dstintf wan1
set scraddr Internal_subnet
set dstaddr Fortinet-web-sites
set action accept
set service webproxy
set schedule always
set groups <User group>
end

end

7. Use the following command to change global web proxy settings, for example to set the maximum request length
for the explicit web proxy to 10:

config web-proxy global
set max-request-length 10

end

8. Determine whether or not to use Botnet feature.
The option scan-botnet-connections uses the following syntax:

config firewall proxy-policy
edit <policy id>

set scan-botnet-connections [disable|block|monitor]
end

Where:

l disable means do not scan connections to botnet servers
l block means block connection to botnet servers
l monitor means log connections to botnet servers

Policy Matching based on Referrer Headers and Query Strings
Web proxy policies support creating web proxy addresses to match referrer headers and query strings.

Matching referrer headers

For example, to create a web proxy address to match the referrer header to block access to the following
YouTube URL http://youtube.com/user/test321. The http request will have the following format:

GET /user/test321 HTTP/1.1
Host: www.youtube.com
User-Agent: curl/7.52.1
Accept: */*

Create the following web proxy addresses to match this page:

config firewall proxy-address
edit youtube
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set type host-regex
set host-regex ".*youtube.com"

next
edit test321

set host "youtube"
set path "/user/test321"
set referrer enable

end

Then create two proxy policies, one that allows access to all traffic and a second one that blocks access to the
page that matches the referrer header:

config firewall proxy-policy
edit 1

set uuid 92273e4e-8c53-51e7-a7bd-f26e6e15fc98
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "all"
set service "webproxy-connect"
set action accept
set schedule "always"
set utm-status enable
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
edit 2

set uuid d35ad06a-8c53-51e7-8511-17200f682a4a
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "test321"
set service "webproxy"
set action accept
set schedule "always"
set utm-status enable
set av-profile "default"
set profile-protocol-options "test"
set ssl-ssh-profile "test"

end

Matching query strings

To match the video with URL youtube.com/watch?v=XXXXXXXXX, (where XXXXXXXXX is an example YouTube
query string) you need to match an HTTP request with the following format:

GET /user/watch?v=GLCHldlwQsg HTTP/1.1
Host: www.youtube.com
User-Agent: curl/7.52.1
Accept: */*

Create the following web proxy addresses to match this video or query string:

config firewall proxy-address
edit "youtube"

set uuid 4ad63880-971e-51e7-7b2e-c69423ac6314
set type host-regex
set host-regex ".*youtube.com"

next

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1199



Explicit Proxy Concepts Chapter 9 - Firewall

edit "query-string"
set uuid 7687a8c0-9727-51e7-5063-05edda03abbf
set host "youtube"
set path "/watch"
set query "v=XXXXXXXXX"

end

Then create two proxy policies, one that allows access to all traffic and a second one that blocks access to the
page that matches the query string

config firewall proxy-policy
edit 1
set uuid 92273e4e-8c53-51e7-a7bd-f26e6e15fc98

set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "all"
set service "webproxy-connect"
set action accept
set schedule "always"
set utm-status enable
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
edit 2

set uuid d35ad06a-8c53-51e7-8511-17200f682a4a
set proxy explicit-web
set dstintf "wan2"
set srcaddr "all"
set dstaddr "query-string"
set service "webproxy"
set action accept
set schedule "always"
set utm-status enable
set av-profile "default"
set profile-protocol-options "test"
set ssl-ssh-profile "test"

next
end

Explicit Proxy Concepts

The following is information that is specific to Explicit Proxy concepts. Any information that is common to Web
Proxy in general is covered in the more inclusive section of Web Proxy Concepts on page 1187

The FortiGate explicit web proxy
You can use the FortiGate explicit web proxy to enable explicit proxying of IPv4 and IPv6 HTTP, and HTTPS
traffic on one or more FortiGate interfaces. The explicit web proxy also supports proxying FTP sessions from a
web browser and proxy auto-config (PAC) to provide automatic proxy configurations for explicit web proxy users.
From the CLI you can also configure the explicit web proxy to support SOCKS sessions from a web browser.

The explicit web and FTP proxies can be operating at the same time on the same or on different FortiGate
interfaces.
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If explicit web proxy options are not visible on the GUI, go to System > Settings and
set the Inspection mode to Proxy. Then go to System > Feature Visibility and
turn on Explicit Proxy.

In most cases you would configure the explicit web proxy for users on a network by enabling the explicit web proxy
on the FortiGate interface connected to that network. Users on the network would configure their web browsers to
use a proxy server for HTTP and HTTPS, FTP, or SOCKS and set the proxy server IP address to the IP address of
the FortiGate interface connected to their network. Users could also enter the PAC URL into their web browser
PAC configuration to automate their web proxy configuration using a PAC file stored on the FortiGate unit.

Enabling the explicit web proxy on an interface connected to the Internet is a security
risk because anyone on the Internet who finds the proxy could use it to hide their
source address.

If the FortiGate unit is operating in transparent mode, users would configure their browsers to use a proxy server
with the FortiGate management IP address.

If the FortiGate unit is operating with multiple VDOMs the explicit web proxy is configured for each VDOM.

The web proxy receives web browser sessions to be proxied at FortiGate interfaces with the explicit web proxy
enabled. The web proxy uses FortiGate routing to route sessions through the FortiGate unit to a destination
interface. Before a session leaves the exiting interface, the explicit web proxy changes the source addresses of
the session packets to the IP address of the exiting interface. When the FortiGate unit is operating in Transparent
mode the explicit web proxy changes the source addresses to the management IP address. You can configure the
explicit web proxy to keep the original client IP address. See The FortiGate explicit web proxy on page 1200.

For more information about explicit web proxy sessions, see The FortiGate explicit web proxy on page 1200.

Example explicit web proxy topology

To allow all explicit web proxy traffic to pass through the FortiGate unit you can set the explicit web proxy default
firewall policy action to accept. However, in most cases you would want to use security policies to control explicit
web proxy traffic and apply security features such as access control/authentication, virus scanning, web filtering,
application control, and traffic logging. You can do this by keeping the default explicit web proxy security policy
action to deny and then adding web-proxy security policies.

You can also change the explicit web proxy default security policy action to accept and add explicit web proxy
security policies. If you do this, sessions that match web-proxy security policies are processed according to the
security policy settings. Connections to the explicit web proxy that do not match a web-proxy security policy are
allowed with no restrictions or additional security processing. This configuration is not recommended and is not a
best practice.

The explicit web-proxy can accept VIP addresses for destination address. If an external IP matches a VIP policy,
the IP is changed to the mapped-IP of the VIP.

Web-proxy policies can selectively accept or deny traffic, apply authentication, enable traffic logging, and use
security profiles to apply virus scanning, web filtering, IPS, application control, DLP, and SSL/SSH inspection to
explicit web proxy traffic.

You cannot configure IPsec, SSL VPN, or Traffic shaping for explicit web proxy traffic. Web Proxy policies can
only include firewall addresses not assigned to a FortiGate unit interface or with interface set to Any. (On the
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web-based manager you must set the interface to Any. In the CLI you must unset the associated-
interface.)

Authentication of explicit web proxy sessions uses HTTP authentication and can be based on the user’s source IP
address or on cookies from the user’s web browser. For more information, see The FortiGate explicit web proxy
on page 1200.

To use the explicit web proxy, users must add the IP address of a FortiGate interface on which the explicit web
proxy is enabled and the explicit web proxy port number (default 8080) to the proxy configuration settings of their
web browsers.

On FortiGate units that support it, you can also enable web caching for explicit web proxy sessions.

For the time being, traffic shaping is not supported per policy for explicit proxy. For
explicit proxy traffic, traffic shaping can be carried out per interface.

Other explicit web proxy options
You can change the following explicit web proxy options as required by your configuration.

HTTP port, HTTPS port, FTP port, PAC port

The TCP port that web browsers use to connect to the explicit proxy for HTTP, HTTPS, FTP and PAC services.
The default port is 8080 for all services. By default HTTPS, FTP. and PAC use the same port as HTTP. You can
change any of these ports as required. Users configuring their web browsers to use the explicit web proxy should
add the same port numbers to their browser configurations.

Multi-port support for Explicit Proxy

Support exists for the use of multiple ports and port range in the explicit FTP or Web proxies.These changes have
been added in both CLI and GUI.

CLI:

set http-incoming-port <port_low>[-<port_high>]

Where:

l port_low - the low value of the port
l port_high - the high value of the port

The port_high value can be omitted if port_low and port_high are the same.

Proxy FQDN

Enter the fully qualified domain name (FQDN) for the proxy server. This is the domain name to enter into
browsers to access the proxy server.

Max HTTP request length

Enter the maximum length of an HTTP request in Kbytes. Larger requests will be rejected.
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Max HTTP message length

Enter the maximum length of an HTTPmessage in Kbytes. Larger messages will be rejected.

Multiple incoming ports and port ranges

Web proxy can be configured to listen on multiple ports on the same IP as well as listen for HTTP and HTTPS on
those same (or different) ports. This is done in the CLI.

Define the IP ranges using a hyphen (-). As shown below, port_high is not necessary to specify if port_low is
equal to port_high.

CLI syntax

config web-proxy explicit
set http-incoming-port <port_low> [-<port_high>]

end

Internet services

FortiOS can use the Internet Service Database (introduced in 5.4.1) as a web-proxy policy matching factor. This
can only be done in the CLI.

CLI syntax:

config firewall proxy-policy
edit 0

set internet-service <application-id>
set internet-service-custom <application-name>

IP Pools

IP Pools can be used with web proxy. When using this option of setting the IP pool name, the outgoing IP will be
selected.

CLI syntax

config firewall proxy-policy
edit <example>

set poolname <name>
end

Proxy chaining (web proxy forwarding servers)
For the explicit web proxy you can configure web proxy forwarding servers to use proxy chaining to redirect web
proxy sessions to other proxy servers. Proxy chaining can be used to forward web proxy sessions from the
FortiGate unit to one or more other proxy servers on your network or on a remote network. You can use proxy
chaining to integrate the FortiGate explicit web proxy with an web proxy solution that you already have in place.

A FortiGate unit can forward sessions to most web proxy servers including a remote FortiGate unit with the
explicit web proxy enabled. No special configuration of the explicit web proxy on the remote FortiGate unit is
required.

You can deploy the explicit web proxy with proxy chaining in an enterprise environment consisting of small
satellite offices and a main office. If each office has a FortiGate unit, users at each of the satellite offices can use
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their local FortiGate unit as an explicit web proxy server. The satellite office FortiGate units can forward explicit
web proxy sessions to an explicit web proxy server at the central office. From here the sessions can connect to
web servers on the Internet.

FortiGate proxy chaining does not support authenticating with the remote forwarding server.

Adding a web proxy forwarding server

To add a forwarding server, select Create New in the Web Proxy Forwarding Servers section of the Explicit
Proxy page by going to Network > Explicit Proxy.

Server Name Enter the name of the forwarding server.

Proxy Address Enter the IP address of the forwarding server.

Proxy Address
Type

Select the type of IP address of the forwarding server. A forwarding server can have an
FQDN or IP address.

Port
Enter the port number on which the proxy receives connections. Traffic leaving the
FortiGate explicit web proxy for this server has its destination port number changed to
this number.

Server Down
action

Select what action the explicit web proxy to take if the forwarding server is down.

Blockmeans if the remote server is down block traffic.

Use Original Servermeans do not forward traffic to the forwarding sever but instead
forward it from the FortiGate to its destination. In other words operate as if there is no
forwarding server configured.

Enable Health
Monitor Select to enable health check monitoring and enter the address of a remote site. See

“Web proxy forwarding server monitoring and health checking”.Health Check
Monitor Site

Use the following CLI command to add a web proxy forwarding server named fwd-srv at address
proxy.example.com and port 8080.

config web-proxy forward-server
edit fwd-srv

set addr-type fqdn
set fqdn proxy.example.com
set port 8080

end

Web proxy forwarding server monitoring and health checking

By default, a FortiGate unit monitors web proxy forwarding server by forwarding a connection to the remote server
every 10 seconds. If the remote server does not respond it is assumed to be down. Checking continues and when
the server does send a response the server is assumed to be back up. If you configure health checking, every 10
seconds the FortiGate unit attempts to get a response from a web server by connecting through the remote
forwarding server.
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You can configure health checking for each remote server and specify a different website to check for each one.

If the remote server is found to be down you can configure the FortiGate unit to block sessions until the server
comes back up or to allow sessions to connect to their destination, bypassing the remote forwarding server. You
cannot configure the FortiGate unit to fail over to another remote forwarding server.

Configure the server down action and enable health monitoring from the web-based manager by going to
Network > Explicit Proxy, selecting a forwarding server, and changing the server down action and changing
the health monitor settings.

Use the following CLI command to enable health checking for a web proxy forwarding server and set the server
down option to bypass the forwarding server if it is down.

config web-proxy forward-server
edit fwd-srv

set healthcheck enable
set monitor http://example.com
set server-down-option pass

end

Grouping forwarding servers and load balancing traffic to them

You can add multiple web proxy forwarding servers to a forwarding server group and then add the server group to
an explicit web proxy policy instead of adding a single server. Forwarding server groups are created from the
FortiGate CLI but can be added to policies from the web-based manager (or from the CLI).

When you create a forwarding server group you can select a load balancing method to control how sessions are
load balanced to the forwarding servers in the server group. Two load balancing methods are available:

l Weighted load balancing sends more sessions to the servers with higher weights. You can configure the weight for
each server when you add it to the group.

l Least-session load balancing sends new sessions to the forwarding server that is processing the fewest sessions.

When you create a forwarding server group you can also enable affinity. Enable affinity to have requests from the
same client processed by the same server. This can reduce delays caused by using multiple servers for a single
multi-step client operation. Affinity takes precedence over load balancing.

You can also configure the behavior of the group if all of the servers in the group are down. You can select to
block traffic or you can select to have the traffic pass through the FortiGate explicit proxy directly to its
destination instead of being sent to one of the forwarding servers.

Use the following command to add a forwarding server group that users weighted load balancing to load balance
traffic to three forwarding servers. Server weights are configured to send most traffic to server2. The group has
affinity enabled and blocks traffic if all of the forward servers are down:

config web-proxy forward-server
edit server_1

set ip 172.20.120.12
set port 8080

next
edit server_2

set ip 172.20.120.13
set port 8000

next
edit server_3

set ip 172.20.120.14
set port 8090

next
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end
config web-proxy forward-server-group

edit New-fwd-group
set affinity enable
set ldb-method weight
set group-down-option block

config server-list
edit server_1

set weight 10
next
edit server_2

set weight 40
next
edit server_3

set weight 10
next

end

Adding proxy chaining to an explicit web proxy policy

You enable proxy chaining for web proxy sessions by adding a web proxy forwarding server or server group to an
explicit web proxy policy. In a policy you can select one web proxy forwarding server or server group. All explicit
web proxy traffic accepted by this security policy is forwarded to the specified web proxy forwarding server or
server group.

To add an explicit web proxy forwarding server - web-based manager:

1. Go to Policy & Objects > Proxy Policy and select Create New.
2. Configure the policy:

Explicit Proxy Type Web

Source Address Internal_subnet

Outgoing Interface wan1

Destination Address all

Schedule always

Action ACCEPT

Web Proxy Forwarding
Server

Select, fwd-srv

3. Select OK to save the security policy.

To add an explicit web proxy forwarding server - CLI:

1. Use the following command to add a security policy that allows all users on the 10.31.101.0 subnet to use the
explicit web proxy for connections through the wan1 interface to the Internet. The policy forwards web proxy
sessions to a remote forwarding server named fwd-srv

config firewall proxy-policy
edit 0

set proxy explicit-web
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set dstintf wan1
set scraddr Internal_subnet
set dstaddr all
set action accept
set schedule always
set webproxy-forward-server fwd-srv

end

Security profiles, threat weight, device identification, and the explicit web proxy
You can apply all security profiles to explicit web proxy sessions. This includes antivirus, web filtering, intrusion
protection (IPS), application control, data leak prevention (DLP), and SSL/SSH inspection. Security profiles are
applied by selecting them in an explicit web proxy policy or in authentication rules added to web proxy policies.

Traffic accepted by explicit web proxy policies contributes to threat weight data.

The explicit web proxy is not compatible with device identification.

Since the traffic accepted by the explicit web proxy is known to be either HTTP, HTTPS, or FTP over HTTP and
since the ports are already known by the proxy, the explicit web proxy does not use all of the SSL/SSH inspection
options. The explicit web proxy does support the following proxy options:

l Enable chunked bypass
l HTTP oversized file action and threshold

The explicit web proxy does not support the following proxy options:

l Client comforting
l Server comforting
l Monitor content information from dashboard. URLs visited by explicit web proxy users are not added to dashboard

usage and log and archive statistics widgets.

For explicit web proxy sessions, the FortiGate unit applies antivirus scanning to HTTP POST requests and HTTP
responses. The FortiGate unit starts virus scanning a file in an HTTP session when it receives a file in the body of
an HTML request. The explicit web proxy can receive HTTP responses from either the originating web server or
the FortiGate web cache module.

Explicit web proxy sessions and user limits
Web browsers and web servers open and close multiple sessions with the explicit web proxy. Some sessions open
and close very quickly. HTTP 1.1 keepalive sessions are persistent and can remain open for long periods of time.
Sessions can remain on the explicit web proxy session list after a user has stopped using the proxy (and has, for
example, closed their browser). If an explicit web proxy session is idle for more than 3600 seconds it is torn down
by the explicit web proxy. See RFC 2616 for information about HTTP keepalive/persistent HTTP sessions.

This section describes proxy sessions and user limits for both the explicit web proxy and the explicit FTP proxy.
Session and user limits for the two proxies are counted and calculated together. However, in most cases if both
proxies are active there will be many more web proxy sessions than FTP proxy sessions.

The FortiGate unit adds two sessions to its session table for every explicit proxy session started by a web browser
and every FTP session started by an FTP client. An entry is added to the session table for the session from the
web browser or client to the explicit proxy. All of these sessions have the same destination port as the explicit web
proxy port (usually 8080 for HTTP and 21 for FTP). An entry is also added to the session table for the session
between the exiting FortiGate interface and the web or FTP server destination of the session. All of these
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sessions have a FortiGate interface IP address and the source address of the session and usually have a
destination port of 80 for HTTP and 21 for FTP.

Proxy sessions that appear in FortiView do not include the Policy ID of the web-proxy or ftp-proxy security policy
that accepted them. However, the explicit proxy sessions include a destination port that matches the explicit
proxy port number (usually 8080 for the web proxy and 21 for the FTP proxy). The proxied sessions from the
FortiGate unit have their source address set to the IP address of the FortiGate unit interface that the sessions use
to connect to their destinations (for example, for connections to the Internet the source address would be the IP
address of the FortiGate interface connected to the Internet).

FortiOS limits the number of explicit proxy users. This includes both explicit FTP proxy and explicit web proxy
users. The number of users varies by FortiGate model from as low as 10 to up to 18000 for high end models. You
cannot raise this limit.

If your FortiGate unit is configured for multiple VDOMs you can go to System > Global Resourcesto view the
maximum number of Concurrent explicit proxy users and optionally reduce the limit. You can also use the
following command:

config global
config system resource-limits

set proxy 50
end

end

To limit the number of explicit proxy users for a VDOM, from the web-based manager enable multiple VDOMs
and go to System > VDOM and edit a VDOM or use the following command to change the number of explicit
web proxy users for VDOM_1:

config global
config system vdom-property

edit VDOM_1
set proxy 25

end
end

You can use the diagnose wad user list command to view the number of explicit web proxy users. Users
may be displayed with this command even if they are no longer actively using the proxy. All idle sessions time out
after 3600 seconds.

You can use the command diagnose wad user clear to clear current explicit proxy users. You can also
use the command diagnose wad user clear <user-name> to clear individual users. This means delete
information about all users and force them re-authenticate.

Users that authenticate with explicit web-proxy or ftp-proxy security policies do not
appear in theMonitor > Firewall User Monitor list and selecting De-authenticate
All Users has no effect on explicit proxy users.

How the number of concurrent explicit proxy users is determined depends on their authentication method:

l For session-based authenticated users, each authenticated user is counted as a single user. Since multiple users
can have the same user name, the proxy attempts to identify users according to their authentication membership
(based upon whether they were authenticated using RADIUS, LADAP, FSAE, local database etc.). If a user of one
session has the same name and membership as a user of another session, the explicit proxy assumes this is one
user.
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l For IP Based authentication, or no authentication, or if no web-proxy security policy has been added, the source IP
address is used to determine a user. All sessions from a single source address are assumed to be from the same
user.

The explicit proxy does not limit the number of active sessions for each user. As a result the actual explicit proxy
session count is usually much higher than the number of explicit web proxy users. If an excessive number of
explicit web proxy sessions is compromising system performance you can limit the amount of users if the
FortiGate unit is operating with multiple VDOMs.

Explicit Proxy Configuration

The following is information that is specific to Explicit Proxy configuration. Any configuration information that is
common to Web Proxy in general is covered in the more inclusive section of Web Proxy Configuration on page
1194.

Configuring an external IP address for the IPv4 explicit web proxy
You can use the following command to set an external IP address (or pool) that will be used by the explicit web
proxy policy.

config web-proxy explicit
set status enable
set outgoing-ip <ip1> <ip2> ... <ipN>

end

Configuring an external IP address for the IPv6 explicit web proxy
You can use the following command to set an external IP address (or pool) that will be used by the explicit web
proxy policy.

config web-proxy explicit
set status enable
set outgoing-ipv6 <ip1> <ip2> ... <ipN>

end

Restricting the IP address of the IPv4 explicit web proxy
You can use the following command to restrict access to the explicit web proxy using only one IP address. The IP
address that you specify must be the IP address of an interface that the explicit web proxy is enabled on. You
might want to use this option if the explicit FTP proxy is enabled on an interface with multiple IP addresses.

For example, to require uses to connect to the IP address 10.31.101.100 to connect to the explicit web proxy:

config web-proxy explicit
set incoming-ip 10.31.101.100

end

Restricting the outgoing source IP address of the IPv4 explicit web proxy
You can use the following command to restrict the source address of outgoing web proxy packets to a single IP
address. The IP address that you specify must be the IP address of an interface that the explicit web proxy is
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enabled on. You might want to use this option if the explicit web proxy is enabled on an interface with multiple IP
addresses.

For example, to restrict the outgoing packet source address to 172.20.120.100:

config web-proxy explicit
set outgoing-ip 172.20.120.100

end

Restricting the IP address of the explicit IPv6 web proxy
You can use the following command to restrict access to the IPv6 explicit web proxy to use only one IP6 IP
address. The IPv6 address that you specify must be the IPv6 address of an interface that the explicit web proxy is
enabled on. You might want to use this option if the explicit web proxy is enabled on an interface with multiple
IPv6 addresses.

For example, to require uses to connect to the IPv6 address 2001:db8:0:2::30 to connect to the explicit IPv6 web
proxy:

config web-proxy explicit
set incoming-ipv6 2001:db8:0:2::30

end

Restricting the outgoing source IP address of the IPv6 explicit web proxy
You can use the following command to restrict the source address of outgoing web proxy packets to a single IPv6
address. The IP address that you specify must be the IPv6 address of an interface that the explicit web proxy is
enabled on. You might want to use this option if the explicit web proxy is enabled on an interface with multiple
IPv6 addresses.

For example, to restrict the outgoing packet source address to 2001:db8:0:2::50:

config web-proxy explicit
set outgoing-ipv6 2001:db8:0:2::50

end

Explicit proxy firewall address types
Explicit proxy firewall address types improve granularity over header matching for explicit web proxy policies. You
can enable this option using the Show in Address List button on the Address and Address Group New/Edit
forms under Policy & Objects > Addresses.

The following address types are available:

l URL Pattern - destination address
l Host Regex Match - destination address
l URL Category - destination address (URL filtering)
l HTTP Method - source address
l User Agent - source address
l HTTP Header - source address
l Advanced (Source) - source address (combines User Agent, HTTP Method, and HTTPHeader)
l Advanced (Destination) - destination address (combines Host Regex Match and URL Category)
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Proxy auto-config (PAC) configuration
A proxy auto-config (PAC) file defines how web browsers can choose a proxy server for receiving HTTP content.
PAC files include the FindProxyForURL(url, host) JavaScript function that returns a string with one or more access
method specifications. These specifications cause the web browser to use a particular proxy server or to connect
directly.

To configure PAC for explicit web proxy users, you can use the port that PAC traffic from client web browsers use
to connect to the explicit web proxy. explicit web proxy users must configure their web browser’s PAC proxy
settings to use the PAC port.

PAC File Content

You can edit the default PAC file from the web-based manager or use the following command to upload a custom
PAC file:

config web-proxy explicit
set pac-file-server-status enable
set pac-file-data <pac_file_str>

end

Where <pac_file_str> is the contents of the PAC file. Enter the PAC file text in quotes. You can copy the
contents of a PAC text file and paste the contents into the CLI using this option. Enter the command followed by
two sets of quotes then place the cursor between the quotes and paste the file content.

The maximum PAC file size is 256 kbytes. If your FortiGate unit is operating with multiple VDOMs each VDOM
has its own PAC file. The total amount of FortiGate memory available to store all of these PAC files 2 MBytes. If
this limit is reached you will not be able to load any additional PAC files.

You can use any PAC file syntax that is supported by your users’s browsers. The FortiGate unit does not parse the
PAC file.

To use PAC, users must add an automatic proxy configuration URL (or PAC URL) to their web browser proxy
configuration. The default FortiGate PAC file URL is:

http://<interface_ip>:<PAC_port_int>/<pac_file_str>

For example, if the interface with the explicit web proxy has IP address 172.20.120.122, the PAC port is the same
as the default HTTP explicit web proxy port (8080) and the PAC file name is proxy.pac the PAC file URL would be:

http://172.20.120.122:8080/proxy.pac

From the CLI you can use the following command to display the PAC file URLs:

get web-proxy explicit

Unknown HTTP version
You can select the action to take when the proxy server must handle an unknown HTTP version request or
message. Set unknown HTTP version to Reject or Best Effort. Best Effort attempts to handle the HTTP traffic as
best as it can. Reject treats known HTTP traffic as malformed and drops it. The Reject option is more secure.

Authentication realm
You can enter an authentication realm to identify the explicit web proxy. The realm can be any text string of up to
63 characters. If the realm includes spaces enclose it in quotes. When a user authenticates with the explicit web
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proxy the HTTP authentication dialog includes the realm so you can use the realm to identify the explicitly web
proxy for your users.

Implementing Botnet features
The option scan-botnet-connections can be added to an explicit proxy policy.

CLI Syntax:
config firewall proxy-policy

edit <policy_id>
set scan-botnet-connections [disable|block|monitor]

end

where:

l disable means do not scan connections to botnet servers.
l block means block connections to botnet servers.
l monitor means log connections to botnet servers.

Adding disclaimer messages to explicit proxy policies
This feature allows you to create user exceptions for specific URL categories (including warning messages) based
on user groups. The Disclaimer Options are configured under Policy & Objects > Proxy Policy.

You can also configure a disclaimer for each Authentication Rule by setting Action to Authenticate.

Disclaimer explanations

l Disable:No disclaimer (default setting).
l By Domain: The disclaimer will be displayed on different domains. The explicit web proxy will check the

referring header to mitigate the javascript/css/images/video/etc page.
l By Policy: The disclaimer will be displayed if the HTTP request matches a different explicit firewall policy.
l By User: The disclaimer will be displayed when a new user logs on.

Changing HTTP headers
You can create explicit web proxy profiles that can add, remove and change HTTP headers. The explicit web
proxy profile can be added to a web explicit proxy policy and will be applied to all of the HTTP traffic accepted by
that policy.

You can change the following HTTP headers:

l client-ip
l via header for forwarded requests
l via header for forwarded responses
l x-forwarded-for
l front-end-https

For each of these headers you can set the action to:

l Pass to forward the traffic without changing the header
l Add to add the header
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l Remove to remove the header

You can also configure how the explicit web proxy handles custom headers. The proxy can add or remove custom
headers from requests or responses. If you are adding a header you can specify the content to be included in the
added header.

Create web proxy profiles from the CLI:

config web-proxy profile
edit <name>

set header-client-ip {add | pass | remove}
set header-via-request {add | pass | remove}
set header-via-response {add | pass | remove}
set header-x-forwarded-for {add | pass | remove}
set header-front-end-https {add | pass | remove}

config headers
edit <id>

set action {add-to-request | add-to-response | remove-from-request |
remove-from-response}

set content <string>
set name <name>

end
end

Use the following command to add a web proxy profile to an explicit proxy policy:

config firewall proxy-policy
edit <id>

set webproxy-profile <name>
end

Preventing the explicit web proxy from changing source addresses
By default in NAT mode the explicit web proxy changes the source address of packets leaving the FortiGate to the
IP address of the FortiGate interface that the packets are exiting from. In Transparent mode the source address
is changed to the management IP.

This configuration hides the IP addresses of clients and allows packets to return to the FortiGate unit interface
without having to route packets from clients. You can use the following command to configure the explicit web
proxy to keep the original client’s source IP address:

config firewall proxy-policy
edit 0

set proxy explicit-web
set transparent enable

end

Example users on an internal network browsing the Internet through the explicit web proxy
with web caching, RADIUS authentication, web filtering, and virus scanning

This example describes how to configure the explicit web proxy for the example network shown below. In this
example, users on the internal network connect to the explicit web proxy through the Internal interface of the
FortiGate unit. The explicit web proxy is configured to use port 8888 so users must configure their web browser
proxy settings to use port 8888 and IP address 10.31.101.100.

Example explicit web proxy network topology
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Explicit web proxy users must authenticate with a RADIUS server before getting access to the proxy. The explicit
proxy policy that accepts explicit web proxy traffic applies per session authentication and includes a RADIUS
server user group. The authentication rule also applies web filtering and virus scanning.

General configuration steps

This section breaks down the configuration for this example into smaller procedures. For best results, follow the
procedures in the order given:

1. Enable the explicit web proxy for HTTP and HTTPS and change the HTTP and HTTPS ports to 8888.
2. Enable the explicit web proxy on the internal interface.
3. Add a RADIUS server and user group for the explicit web proxy.
4. Add an authentication explicit proxy policy. Enable web caching. Add an authentication rule and enable antivirus

and web filtering.

Configuring the explicit web proxy - web-based manager

Use the following steps to configure the explicit web proxy.

To enable and configure the explicit web proxy

1. Go to System > Feature Visibility and turn on the Explicit Proxy feature.
2. Go to Network > Explicit Proxy and change the following settings:

Enable Explicit Web Proxy Select HTTP/HTTPS.

Listen on Interfaces No change. This field will eventually show that the explicit web proxy is
enabled for the Internal interface.

HTTP Port 8888

HTTPS Port 0

Realm You are authenticating with the explicit web proxy.

Default Firewall Policy
Action

Deny

3. Select Apply.

To enable the explicit web proxy on the Internal interface

1. Go to Network > Interfaces.
2. Edit the internal interface.
3. Select Enable Explicit Web Proxy.
4. Select OK.

To add a RADIUS server and user group for the explicit web proxy

1. Go to User & Device > RADIUS Servers and select Create New to add a new RADIUS server:
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Name RADIUS_1

Primary Server Name/IP 10.31.101.200

Primary Server Secret RADIUS_server_secret

2. Select OK.
3. Go to User & Device > User Groups and select Create New to add a new user group.

Name Explict_proxy_user_group

Type Firewall

Remote Groups RADIUS_1

Group Name Any

4. Select OK.

To add an explicit proxy policy

1. Go to Policy & Objects > Addresses and select Create New.
2. Add a firewall address for the internal network:

Category Address

Name Internal_subnet

Type Subnet / IP Range

Subnet / IP Range 10.31.101.0

Interface Any

3. Go to Policy & Objects > Proxy Policy and select Create New.
4. Configure the explicit web proxy policy.

Explicit Proxy Type Web

Source Address Internal_subnet

Outgoing Interface wan1

Destination Address all

Action AUTHENTICATE

5. UnderConfigure Authentication Rules select Create New to add an authentication rule:

Groups Explicit_policy
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Source User(s) Leave blank

Schedule always

6. Turn on Antivirus andWeb Filter and select the default profiles for both.
7. Select the default proxy options profile.
8. Select OK.
9. Make sure Enable IP Based Authentication is not selected.
10. Turn onWeb Cache.
11. Select OK.

Configuring the explicit web proxy - CLI

Use the following steps to configure the example explicit web proxy configuration from the CLI.

To enable the explicit web proxy on the Internal interface

1. Enter the following command to enable the explicit web proxy on the internal interface.
config system interface

edit internal
set explicit-web-proxy enable

end

To enable and configure the explicit web proxy

1. Enter the following command to enable the explicit web proxy and set the TCP port that proxy accepts HTTP and
HTTPS connections on to 8888.

config web-proxy explicit
set status enable
set http-incoming-port 8888
set https-incoming-port 8888
set realm "You are authenticating with the explicit web proxy"
set sec-default-action deny

end

To add a RADIUS server and user group for the explicit web proxy

1. Enter the following command to add a RADIUS server:
config user radius

edit RADIUS_1
set server 10.31.101.200
set secret RADIUS_server_secret

end

2. Enter the following command to add a user group for the RADIUS server.
config user group

edit Explicit_proxy_user_group
set group-type firewall
set member RADIUS_1

end
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To add a security policy for the explicit web proxy

1. Enter the following command to add a firewall address for the internal subnet:
config firewall address

edit Internal_subnet
set type iprange
set start-ip 10.31.101.1
set end-ip 10.31.101.255

end

2. Enter the following command to add the explicit web proxy security policy:
config firewall proxy-policy

edit 0
set proxy explicit-web
set dstintf wan1
set srcaddr Internal_subnet
set dstaddr all
set action accept
set service webproxy
set webcache enable
set identity-based enable
set ipbased disable
set active-auth-method basic
set groups <User group>
end

Testing and troubleshooting the configuration

You can use the following steps to verify that the explicit web proxy configuration is working as expected:

To test the explicit web proxy configuration

1. Configure a web browser on the internal subnet to use a web proxy server at IP address 10.31.101.100 and port
8888.

2. Browse to an Internet web page.
The web browser should pop up an authentication window that includes the phrase that you added to the Realm
option.

3. Enter the username and password for an account on the RADIUS server.
If the account is valid you should be allowed to browse web pages on the Internet.

4. Close the browser and clear its cache and cookies.
5. Restart the browser and connect to the Internet.

You could also start a second web browser on the same PC. Or you could start a new instance of the same
browser as long as the browser asks for a user name and password again.

You should have to authenticate again because identity-based policies are set to session-based authentication.
6. If this basic functionality does not work, check your FortiGate and web browser configuration settings.
7. Browse to a URL on the URL filter list and confirm that the web page is blocked.
8. Browse to http://eicar.org and attempt to download an anti-malware test file.

The antivirus configuration should block the file.
Sessions for web-proxy security policies do not appear on the Top Sessions dashboard widget and the count
column for security policies does not display a count for explicit web proxy security policies.

9. You can use the following command to display explicit web proxy sessions
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get test wad 60
IP based users:

Session based users:
user:0x9c20778, username:User1, vf_id:0, ref_cnt:9

Total allocated user:1

Total user count:3, shared user quota:50, shared user count:3

This command output shows one explicit proxy user with user name User1 authenticated using
session-based authentication.

Kerberos and NTLM authentication
FortiOS recognizes the client's authentication method from the token and selects the correct authentication
scheme to authenticate successfully.

CLI syntax

config firewall proxy-policy
edit 0

set active-auth-method [ntlm|basic|digest|negotiate|none]
end

Kerberos authentication for explicit proxy users
Kerberos authentication is a method for authenticating both explicit web proxy and transparent web proxy users.
It has several advantages over NTLM challenge response:

l Does not require FSSO/AD agents to be deployed across domains.
l Requires fewer round-trips than NTLM SSO, making it less latency sensitive.
l Is (probably) more scalable than challenge response.
l Uses existing Windows domain components rather than added components.
l NTLM may still be used as a fallback for non-Kerberos clients.

Enhancements to Kerberos explicit and transparent web proxy

FortiOS 5.6.x authentication is managed by schemes and rules based on protocol and source address. As such,
configurable authentication settings have been introduced to enhance authentication.

CLI commands (config authentication rule, scheme, and setting) allow explicit proxy rules and
schemes to be created to separate user authentication (e.g. authentication rules and schemes used to match
conditions in order to identify users) from user authorization (proxy-based policies with users and/or user groups).

CLI syntax - config authentication rule

config authentication rule
edit <name>

set name <name>
set status {enable|disable}
set protocol {http|ftp|socks}
config srcaddr <addr-name or addrgrp-name>

edit <name>
set name <ipv4-policy-name>

next
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end
config srcaddr6 <addr-name or addrgrp-name>

edit <name>
set name <ipv6-policy-name>

next
end
set ip-based {enable|disable}
set active-auth-method <scheme-name>
set sso-auth-method <scheme-name>
set transaction-based {enable|disable} - basic scheme + session-based
set web-auth-cookie {enable|disable}
set comments <comments>

next
end

Note: As shown above, HTTP, FTP, and SOCKSv5 authentication protocols are supported for explicit proxy.

Authentication rules are used to receive user-identity, based on the values set for protocol and source address.
Having said this, if a rule fails to match based on source address, there will be no other attempt to match the rule,
however the next policy will be attempted. This occurs only when:

l there is an authentication rule, but no authentication method has been set (under config authentication
scheme; see below), so user identity cannot be found.

l the user is successfully matched in the rule, but fails to match the current policy.

Once a rule is positively matched through protocol and/or source address, it must also match the authentication
method specified (active-auth-method and sso-auth-method). These methods point to schemes, as
defined under config authentication scheme.

CLI syntax - config authentication scheme

config authentication scheme
edit <name>

set name <name>
set method {basic|digest|ntlm|form|negotiate|fsso|rsso}
set negotiate-ntlm {enable|disable}
set require-tfa {enable|disable}
set fsso-guest {enable|disable}
config user-database

edit <name>
set name {local|<ldap-server>|<radius-server>|<fsso-name>|<rsso-name>|<tacacs+-

name>}
next

end
next

end

Combining authentication rules and schemes, granular control can be exerted over users and IPs, creating an
efficient process for users to successfully match a criteria before matching the policy.

Additional options can be set under config authentication setting.

CLI syntax - config authentication setting

config authentication setting
set sso-scheme <scheme-name>
set active-scheme <scheme-name>
set captive-portal <host-name>
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set captive-portal-port <tcp-port>
end

Integration of Transparent and Explicit proxy HTTP policy checking

ACLI command, under config firewall profile-protocol-options, allows HTTP policy checking
to be enable or disabled. When enabled, transparent traffic can be matched in a firewall policy and policy user
authentication can occur. In addition, separate SSL inspection policies can be created:

config firewall profile-protocol-options
edit <name>

set http-policy {enable|disable}
end

Internet Service Database in Explicit/Implicit proxy policies

CLI commands, under config firewall proxy-policy, implement the Internet Service Database (ISDB)
as the webproxy matching factor, and override IP pool is also support:

config firewall proxy-policy
edit <name>

set proxy {explicit-web|transparent-web|ftp|wanopt}
set dstintf <dst-name>
set poolname <ip-pool-name>

end

Multiple port/port range support for explicit web and explicit FTP proxy

Multiple port numbers and/or ranges can be set for explicit proxy, specifically for HTTP/HTTPS and FTP. Go to
Network > Explicit Proxy and configure settings under Explicit Web Proxy and Explicit FTP Proxy, or
under config web-proxy explicit in the CLI Console.

1. General configuration

1.1 Kerberos environment - Windows server setup

1. Build a Windows 2008 Platform server.
2. Enable domain configuration in windows server (dcpromo).
3. Set the domain name TEST.COM (realm name).

1.2 Create users

l testuser is a normal user (could be any existing domain user account).
l testfgt is the service name. In this case it should be the FQDN for the explicit proxy Interface, For example the

hostname in the client browser proxy config.
l Recommendation: create username all in lowercase (even if against corporate standards).

l The account only requires “domain users” membership
l Password set to never expire
l Set a very strong password
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1.3 Add FortiGate to DNS

Add the FortiGate FQDN in to the Windows DNS domain, as well as in-addr.arpa

For Lab/Testing add the FortiGate Domain name and IPmapping in the hosts file
(windows/system32/drivers/etc/hosts). e.g., TESTFGT.TEST.COM 10.10.1.10

1.4 Generate the Kerberos keytab

Use the ktpass command (found on Windows Servers and many domain workstations) to generate the Kerberos
keytab.

Example:

ktpass -princ HTTP/<domain name of test fgt>@realm -mapuser testfgt -pass <password> -
crypto all -ptype KRB5_NT_PRINCIPAL -out fgt.keytab

In the case where the FortiGate is handling multiple keytabs in Kerberos
authentication, use different passwords when generating each keytab.

The ktpass on older Windows servers (i.e. 2003) may not support the “all” crypto
option.

Example:

ktpass -princ HTTP/testfgt.test.com@TEST.COM -mapuser testfgt -pass 12345678 -crypto all -
ptype KRB5_NT_PRINCIPAL -out fgt.keytab

The realm name is always presented in uppercase, and prefixed with the “@”
character.

1.5 Encode base64

Use the base64 command (available in most Linux distros) command to encode the fgt.keytab file. Any LF (Line
Feed) need to be deleted from the file.

Example:

base64 fgt.keytab > fgt.txt

Use Notepad++ or some native Linux text editor. Windows Notepad and Wordpad are
likely to introduce errors.
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2. FortiGate configuration

2.1 Create LDAP Server instance

config user ldap
edit "ldap" <<< Required for authorization

set server "10.10.1.1" <<< LDAP server IP, normally it should be same as KDC server
set cnid "cn"
set dn "dc=test,dc=com"
set type regular
set username "CN=admin,CN=Users,DC=test,DC=com" <<< Your domain may require STARTTLS
set password <FOOS>

next
end

2.2 Define Kerberos as an authentication service

config user krb-keytab
edit "http_service"

set principal "HTTP/testfgt.test.com@TEST.COM" <<< Same as the principal name in 1.4
set ldap-server "ldap" <<< the defined ldap server for authoriztion
set keytab

"BQIAAABNAAIACkJFUkJFUi5DT00ABEhUVFAAGlRPTllfRkdUXzEwMERfQS5CRVJCRVIuQ09NAAAAAQA
AAAAKABcAEJQl0MHqovwplu7XzfENJzw=" <<< base64 endoding keytab data, created in step 1.5

next
end

2.3 Create user group(s)

config user group <<< the group is used for kerberos authentication
edit "testgrp"

set member "ldap"
config match

edit 1
set server-name "ldap" <<< Same as ldap-server option in krb-keytab
set group-name "CN=Domain Users,CN=Users,DC=TEST,DC=com"

next
end

next
end

2.4 Create firewall policy

config firewall proxy-policy
edit 1

set uuid 5e5dd6c4-952c-51e5-b363-120ad77c1414
set proxy explicit-web
set dstintf "port1"
set srcaddr "all"
set dstaddr "all"
set service "webproxy"
set action accept
set schedule "always"
set groups "CN=USERS LAB.PS FSSO"

next
end
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2.5 Diagnostics

Once the keytab is imported, check that it has been properly decoded. The filename generated will be relatively
random, but should be clearly visible.

Artoo-Deetoo (root) # fnsysctl ls -la /tmp/kt
drwxr--r-- 2  0   0 Fri Dec 2 10:06:43 2016    60 .
drwxrwxrwt 22 0   0 Tue Dec 6 14:28:29 2016    3280 ..
-rw-r--r-- 1  0   0 Fri Dec 2 10:06:43 2016    392 1.0.89.keytab

If there is no file present, then the file hasn’t decoded. Check the file for line feeds and
try again.

3. Client side walkthrough

3.1 Check Kerberos is working

Log on to the domain by using testuser, created in 1.2. Use the klist command to list ticket information. In the
below example, the client has received krbtgt, CIFS, and LDAP tickets. As there has been no interaction with the
FortiGate, there are no references to it.

C:\Users\glenk>klist Cached Tickets: (5)

C:\Users\glenk>klist
Cached Tickets: (5)
#0> Client: glenk @ home.local

Server: krbtgt/HOME.LOCAL @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x60a00000 -> forwardable forwarded renewable pre_authent
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#1> Client: glenk @ home.local

Server: krbtgt/HOME.LOCAL @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40e00000 -> forwardable renewable initial pre_authent
Start Time: 12/6/2016 14:58:04 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#2> Client: glenk @ home.local

Server: cifs/EthicsGradient.home.local @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40a40000 -> forwardable renewable pre_authent ok_as_delegate
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#3> Client: glenk @ home.local

Server: ldap/EthicsGradient.home.local @ HOME.LOCAL
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KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40a40000 -> forwardable renewable pre_authent ok_as_delegate
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

#4> Client: glenk @ home.local

Server: LDAP/EthicsGradient.home.local/home.local @ HOME.LOCAL
KerbTicket Encryption Type: AES-256-CTS-HMAC-SHA1-96
Ticket Flags 0x40a40000 -> forwardable renewable pre_authent ok_as_delegate
Start Time: 12/6/2016 14:58:06 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: AES-256-CTS-HMAC-SHA1-96

3.2 Configure client

Set up web-proxy in browser through the FortiGate. This can be achieved via a PAC file or direct browser
configuration.

Some Firefox documentation indicates that it is necessary to make manual advanced
configuration changes to allow Kerberos authentication work. However, builds 48 (and
possibly much earlier) require no additional configuration beyond setting of the proxy
server.

3.3 Open a connection to the Internet

1. The client accesses the explicit proxy, but a HTTP 407 Proxy Authentication Required is returned.
2. As “Negotiate” is set, the client has knowledge of the KRBTGT, it requests a ticket from the KDC with a krb-tgs-

reqmessage. This includes the REALM (HOME.LOCAL) in the reg-body section, and the provided instances
SNAME and service (in this case, HTTP/artoo-deetoo.home.local).

3. The KDC responds with a next KRB-TGS-REP.
This ticket is then available on the client.

In the example below, the ticket-granted-service has issued Ticket #2.

#2> Client: glenk @ home.local
Server: HTTP/artoo-deetoo.home.local @ HOME.LOCAL
KerbTicket Encryption Type: RSADSI RC4-HMAC(NT)
Ticket Flags 0x40a00000 -> forwardable renewable pre_authent
Start Time: 12/6/2016 14:59:45 (local)
End Time: 12/7/2016 0:58:04 (local)
Renew Time: 12/13/2016 14:58:04 (local)
Session Key Type: RSADSI RC4-HMAC(NT)

4. The conversation between the client and the proxy continues, as the client responds with the Kerberos ticket in the
response.
The whole process takes less than a second to complete. The user should be visible as a FSSO logon in the
Web UI.
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Transparent web-proxy Kerberos authentication

Transparent web-proxy is new to FortiOS 5.6, in which the FortiGate can process level 7 policy matching, even
when the explicit web-proxy is not enabled on the client's browser. The transparent web-proxy policy is set in
proxy-policy too. The policy matching rule is the same as the explicit web-proxy.

In the firewall policy level, transparent web-proxy is regarded as a special UTM. The HTTP/HTTPS traffic
matches the firewall policy first, then traffic is redirected to the web-proxy daemon. If the trasnparent web-proxy
feature is disabled, http-policy options in profile-protocol-options is used to enable transparent web-proxy feature.

IP-based

1. Captive portal and the captive portal port must be configured in transparent web-proxy for support of Kerberos
authentication:

config authentication setting
set captive-portal <fqdn-name>
set captive-portal-port "9998"

end

2. Authentication rule, scheme, and krb-keytab need to be configured for Kerberos authentication (note the
active-auth-method scheme referenced in the rule):

config authentication scheme
edit <kerberos-scheme>

set method negotiate
set negotiate-ntlm <enable>
set fsso-guest <disable>

next
end

config authentication rule
edit <name>

set status <enable>
set protocol <http>
set srcadrr "all"
set ip-based <enable>
set active-auth-method <kerberos-scheme>

next
end

config user krb-keytab
edit <name>

set principal "HTTP/TESTFGT.TEST.COM@TEST.COM"
set ldap-server "ldap"
set keytab <base64-encoding-keytab-data>

next
end

3. Configure LDAP and user group used for authorization:

config user ldap
edit "ldap"

set server "10.10.1.1"
set cnid
srt dn
set type <regular>
set username "CN=admin,CN=Users,DC=test,DC=com"
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set password ENC
aW5lIAHkPMf4D+ZCKpGMU3x8Fpq0G+7uIbAvpblbXFA5vLfgb4/oRBx+B6R/v+CMCetP84e+Gdz5zEcM
yOd3cjoBoIhFrpYJfXhRs4lSEOHezeVXfxwTSf5VJG+F11G/G5RpaY+AE8bortC8MBe7P2/uGQocFHu4
Ilulp5I6OJvyk6Ei3hDZMjTd8iPp5IkRJZVVjQ==

next
end

config user group
edit "testgrp"

set memeber "ldap"
config match

edit "1"
set server-name "ldap"
set group-name "CN=Domain Users,CN=Users,DC=TEST,DC=com"

next
end

next
end

4. Create proxy-policy, with groups as the authorizing policy-matching element:

config firewall proxy-policy
edit 1

set uuid 1bbb891a-9cd2-51e7-42ff-d1fa13cac3da
set proxy explicit-web
set dstintf "any"
set srcaddr "all"
set dstaddr "all"
set service "webproxy"
set action accept
set schedule "always"
set groups testgrp

next
end

5. UTM must be enabled in the firewall policy to support the transparent web-proxy:

config firewall policy
edit "1"

set name "policy1"
set uuid 8a6ceeac-b016-51e6-2b5c-165070d5bf50
set srcintf "mgmt1"
set dstintf "mgmt1"
set srcaddr "all"
set dstaddr "all"
set action <accept>
set schedule "always"
set service "ALL"
set utm-status <enable>
set profile-protocol-options "transparent-web-proxy"
set ssl-ssh-profile "deep-inspection"
set nat <enable>

next
end

config firewall profile-protocol-options
edit "transparent-web-proxy"

config http
set ports "80 8080"
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unset options
set http-policy enable
unset post-lang

end
...

next
end

Session-based with web-auth cookie

The web-auth-cookie feature is necessary for session-based authentication under transparent web-proxy.

The configuration is the same as for IP-based authentication, except ip-based is disabled in the authentication
rule:

config authentication rule
edit "kerberos-rules"

set status <enable>
set protocol <http>
set srcadrr "all"
set ip-based <disable>
set active-auth-method <kerberos-scheme>

next

config authentication setting
set captive-portal <fqdn-name>
set captive-portal-port "9998"

end

Transparent Proxy Concepts

In addition to the Explicit Web Proxy, FortiOS supports a Transparent web proxy. While it does not have as many
features as Explicit Web Proxy, the transparent proxy has the advantage that nothing needs to be done on the
user's system to forward supported web traffic over to the proxy. There is no need to reconfigure the browser or
publish a PAC file. Everything is transparent to the end user, hence the name. This makes it easier to incorporate
new users into a proxy deployment.

You can use the transparent proxy to apply web authentication to HTTP traffic accepted by a firewall policy. In
previous versions of FortiOS, web authentication required using the explicit proxy.

Normal FortiOS authentication is IP address based. Users are authenticated according to their IP address and
access is allowed or denied based on this IP address. On networks where authentication based on IP address will
not work you can use the Transparent Web proxy to apply web authentication that is based on the user's browser
and not on their IP address. This authentication method allows you to identify individual users even if multiple
users on your network are connecting to the FortiGate from the same IP address.

More about the transparent proxy
The following changes are incorporated into Transparent proxy, some of which affect Explicit Web Proxy as well.

Flat policies

The split policy feature has been removed. This will make the explicit policy more like the firewall policy.
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Authentication

The authentication design is intended to separate authentication from authorization. Authentication has been
moved into a new table in the FortiOS. This leaves the authorization as the domain of the explicit proxy policy.

Previously, if authentication was to be used:

1. The policy would be classified as an identity based policy
2. The policy would be split to add the authentication parameters
3. The authentication method would be selected
4. The user/group would be configured
Now:

The user/group is configured in the proxy policy

1. A new authentication rule is added
2. This option refers to the authentication scheme
3. The authentication scheme has the details of the authentication method

The new authentication work flow for Transparent Proxy:

Toggle the transparent-http-policy match:

config firewall profile-protocol-options
edit <profile ID>

config http
set http-policy <enable|disable>

If disabled, everything works like before. If enabled, the authentication is triggered differently.

l http-policy work flow:
l For transparent traffic, if there is a regular firewall policy match, when the Layer 7 check option is enabled, traffic

will be redirected to WAD for further processing.
l For redirected traffic, layer 7 policy (HTTP policy) will be used to determine how to do security checks.
l If the last matching factor is down to user ID, then it will trigger a new module to handle the L7 policy user

authentication.
l Then propagate learned user information back to the system so that it can be used to match traffic for L4 policy.

New Proxy Type

There is a new subcategory of proxy in the proxy policy called Transparent Web. The oldWeb Proxy is now
referred to asExplicit Web Proxy.

l This is set in the firewall policy
l It is available when the HTTP policy is enabled in the profile-protocol options for the firewall policy
l This proxy type supports OSI layer 7 address matching.
l This proxy type should include a source address as a parameter
l Limitations:

l It can be used for HTTPS traffic, if deep scanning is not used
l It only supports SNI address matching, i.e. domain names
l It does not support header types of address matching
l It only supports SSO authentication methods, no active authentication methods.
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IP pools support

Proxies are now supported on outgoing IP pools.

SOCKSv5

SOCKSv5 authentication is now supported for explicit proxies.

To configure:

config authentication rule
edit <name of rule>

set protocol socks
end

Forwarding

Proxies support URL redirect/forwarding. This allows a non-proxy forwarding server to be assigned a rule that will
redirect web traffic from one URL to another, such as redirecting traffic destined for youtube.com to
restrict.youtube.com.

l A new option called "Redirect URL" has been added to the policy
l Traffic forwarding by VIP is supported

Support for explicit proxy address objects & groups into IPv4 firewall policies

This would allow the selection of web filter policy, SSL inspection policy, and proxy policy based on source IP +
destination (address|explicit proxy object|category|group of any of those). This enables things like “do full SSL
interception on www.google.com, but not the rest of the Search Engines category”.

Support application service in the proxy based on HTTP requests.

The application service can be configured using the following CLI commands:

config firewall service custom
edit <name of service>
set explicit-proxy enable
set app-service-type <disable|app-id|app-category>
set app-category <application category ID, integer>
set application <application ID, integer>
end

Transparent Proxy Configuration

To implement the Transparent proxy, go to System > Settings and scroll down toOperations Settings and set
the inspection mode to Proxy.
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Then go to System > Feature Visibility and enable Explicit Proxy.

Then go to Security Profiles > Proxy Options, edit a proxy options profile and underWeb Options enable
HTTP Policy Redirect.

Then go to Policy & Objects > IPv4 Policy and create or edit a policy that accepts traffic that you want to
apply web authentication to. This can be a general policy that accepts many different types of traffic as long as it
also accepts the web traffic that you want to apply web authentication to.

Select a Security Profile and select the Proxy Options profile that you enabled HTTP Policy Redirect for.
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Then go to Policy & Objects > Proxy Policy create a Transparent Proxy policy to accept the traffic that you
want to apply web authentication to. Set the Proxy Type to Transparent Web. The incoming interface,
outgoing interface, destination address, and schedule should either match or be a subset of the same options
defined in the IPv4 policy. Addresses added to the Source must match or be a subset of the source addresses
added to the IPv4 policy. You can also add the users to be authenticated by the transparent policy to the source
field.

Select other transparent policy options as required.
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CLI changes due to addition of Transparent Proxy

The adding of Transparent Proxy to the existing proxy types has required some changes, removals, moves and
additions to the CLI.

Changes:

Previous New

config firewall explicit-proxy-policy config firewall proxy-policy
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Previous New

config firewall explicit-proxy-address config firewall proxy-address

config firewall explicit-proxy-addrgrp config firewall proxy-addrgrp

config firewall explicit-proxy-policy
edit <policy ID>

set proxy web
end

config firewall proxy-policy
edit <policy ID>

set proxy explicit-web
end

FTP Proxy Concepts

The FortiGate explicit FTP proxy
You can use the FortiGate explicit FTP proxy to enable explicit FTP proxying on one or more FortiGate interfaces.
The explicit web and FTP proxies can be operating at the same time on the same or on different FortiGate
interfaces.

Explicit FTP proxies are configured for each VDOM when multiple VDOMs are
enabled.

In most cases you would configure the explicit FTP proxy for users on a network by enabling the explicit FTP
proxy on the FortiGate interface connected to that network. Users on the network would connect to and
authenticate with the explicit FTP proxy before connecting to an FTP server. In this case the IP address of the
explicit FTP proxy is the IP address of the FortiGate interface on which the explicit FTP proxy is enabled.

Enabling the explicit FTP proxy on an interface connected to the Internet is a security
risk because anyone on the Internet who finds the proxy could use it to hide their
source address.

If the FortiGate unit is operating in Transparent mode, users would configure their browsers to use a proxy server
with the FortiGate unit management IP address.

The FTP proxy receives FTP sessions to be proxied at FortiGate interfaces with the explicit FTP proxy enabled.
The FTP proxy uses FortiGate routing to route sessions through the FortiGate unit to a destination interface.
Before a session leaves the exiting interface, the explicit FTP proxy changes the source addresses of the session
packets to the IP address of the exiting interface. When the FortiGate unit is operating in Transparent mode the
explicit web proxy changes the source addresses to the management IP address.

Example explicit FTP proxy topology

To allow anyone to anonymously log into explicit FTP proxy and connect to any FTP server you can set the
explicit FTP proxy default firewall proxy action to accept. When you do this, users can log into the explicit FTP
proxy with any username and password.
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In most cases you would want to use explicit proxy policies to control explicit FTP proxy traffic and apply security
features, access control/authentication, and logging. You can do this by keeping the default explicit FTP proxy
firewall policy action to deny and then adding explicit FTP proxy policies. In most cases you would also want users
to authenticate with the explicit FTP proxy. By default an anonymous FTP login is required. Usually you would
add authentication to explicit FTP proxy policies. Users can then authenticate with the explicit FTP proxy
according to users or user groups added to the policies. User groups added to explicit FTP proxy policies can use
any authentication method supported by FortiOS including the local user database and RADIUS and other
remote servers.

If you leave the default firewall policy action set to deny and add explicit FTP proxy policies, all connections to the
explicit FTP proxy must match an or else they will be dropped. Sessions that are accepted are processed
according to the ftp-proxy security policy settings.

You can also change the explicit FTP proxy default firewall policy action to accept and add explicit FTP proxy
policies. If you do this, sessions that match explicit FTP proxy policies are processed according to the policy
settings. Connections to the explicit FTP proxy that do not match an explicit FTP proxy policy are allowed and the
users can authenticate with the proxy anonymously.

There are some limitations to the security features that can be applied to explicit FTP proxy sessions. See The
FortiGate explicit FTP proxy on page 1233.

You cannot configure IPsec, SSL VPN, or Traffic shaping for explicit FTP proxy traffic. Explicit FTP proxy policies
can only include firewall addresses not assigned to a FortiGate unit interface or with interface set to any. (On the
web-based manager you must set the interface to Any. In the CLI you must unset the associated-
interface.)

How to use the explicit FTP proxy to connect to an FTP server
To connect to an FTP server using the explicit FTP proxy, users must run an FTP client and connect to the IP
address of a FortiGate interface on which the explicit FTP proxy is enabled. This connection attempt must use
the configured explicit FTP proxy port number (default 21).

The explicit FTP proxy is not compatible with using a web browser as an FTP client. To use web browsers as FTP
clients configure the explicit web proxy to accept FTP sessions.

The following steps occur when a user starts an FTP client to connect to an FTP server using the explicit FTP
proxy. Any RFC-compliant FTP client can be used. This example describes using a command-line FTP client.
Some FTP clients may require a custom FTP proxy connection script.

1. The user enters a command on the FTP client to connect to the explicit FTP proxy.

For example, if the IP address of the FortiGate interface on which the explicit FTP proxy is enabled is
10.31.101.100, enter:

ftp 10.31.101.100

2. The explicit FTP proxy responds with a welcome message and requests the user’s FTP proxy user name and
password and a username and address of the FTP server to connect to:

Connected to 10.31.101.100.
220 Welcome to FortiGate FTP proxy
Name (10.31.101.100:user):

You can change the message by editing the FTP Explicit Banner Message replacement message.

3. At the prompt the user enters their FTP proxy username and password and a username and address for the FTP
server. The FTP server address can be a domain name or numeric IP address. This information is entered using
the following syntax:
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<proxy-user>:<proxy-password>:<server-user>@<server-address>

For example, if the proxy username and password are p-name and p-pass and a valid username for
the FTP server is s-name and the server’s IP address is ftp.example.com the syntax would be:

p-name:p-pass:s-name@ftp.example.com

If the FTP proxy accepts anonymous logins p-name and p-pass can be any
characters.

4. The FTP proxy forwards the connection request, including the user name, to the FTP server.
5. If the user name is valid for the FTP server it responds with a password request prompt.
6. The FTP proxy relays the password request to the FTP client.
7. The user enters the FTP server password and the client sends the password to the FTP proxy.
8. The FTP proxy relays the password to the FTP server.
9. The FTP server sends a login successful message to the FTP proxy.
10. The FTP proxy relays the login successful message to the FTP client.
11. The FTP client starts the FTP session.

All commands entered by the client are relayed by the proxy to the server. Replies from the server are relayed back
to the FTP client.

Explicit FTP proxy session

From a simple command line FTP client connecting to an the previous sequence could appear as follows:

ftp 10.31.101.100 21
Connected to 10.31.101.100.
220 Welcome to FortiGate FTP proxy
Name (10.31.101.100:user): p-name:p-pass:s-name@ftp.example.com
331 Please specify the password.
Password: s-pass
230 Login successful.
Remote system type is UNIX
Using binary mode to transfer files.
ftp>

Security profiles, threat weight, device identification, and the explicit FTP proxy
You can apply antivirus, data leak prevention (DLP), and SSL/SSH inspection to explicit FTP proxy sessions.
Security profiles are applied by selecting them in an explicit FTP proxy policy or an authentication rule in an FTP
proxy security policy.

Traffic accepted by explicit FTP proxy policies contributes to threat weight data.

The explicit FTP proxy is not compatible with device identification.
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Explicit FTP proxy options and SSL/SSH inspection

Since the traffic accepted by the explicit FTP proxy is known to be FTP and since the ports are already known by
the proxy, the explicit FTP proxy does not use the FTP port proxy options settings.

When adding UTM features to an FTP proxy security policy, you must select a proxy options profile. In most
cases you can select the default proxy options profile. You could also create a custom proxy options profile.

The explicit FTP proxy supports the following proxy options:

l Block Oversized File and oversized file limit

The explicit FTP proxy does not support the following protocol options:

l Client comforting

Explicit FTP proxy sessions and antivirus

For explicit FTP proxy sessions, the FortiGate unit applies antivirus scanning to FTP file GET and PUT requests.
The FortiGate unit starts virus scanning a file in an FTP session when it receives a file in the body of an FTP
request.

Flow-based virus scanning is not available for explicit FTP proxy sessions. Even if the FortiGate unit is configured
to use flow-based antivirus, explicit FTP proxy sessions use the regular virus database.

Explicit FTP proxy sessions and user limits
FTP clients do not open large numbers of sessions with the explicit FTP proxy. Most sessions stay open for a
short while depending on how long a user is connected to an FTP server and how large the file uploads or
downloads are. So unless you have large numbers of FTP users, the explicit FTP proxy should not be adding
large numbers of sessions to the session table.

Explicit FTP proxy sessions and user limits are combined with explicit web proxy session and user limits. For
information about explicit proxy session and user limits, see .

FTP Proxy Configuration

General explicit FTP proxy configuration steps
You can use the following general steps to configure the explicit FTP proxy.

To enable the explicit FTP proxy - web-based manager:

1. Go to Network > Explicit Proxy > Explicit FTP Proxy Options. Select Enable Explicit FTP Proxy to turn
on the explicit FTP proxy.

2. Select Apply.

The Default Firewall Policy Action is set to Deny and requires you to add a explicit FTP proxy policy to allow
access to the explicit FTP proxy. This configuration is recommended and is a best practice because you can use
policies to control access to the explicit FTP proxy and also apply security features and authentication.

3. Go to Network > Interfaces and select one or more interfaces for which to enable the explicit web proxy. Edit the
interface and select Enable Explicit FTP Proxy.
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Enabling the explicit FTP proxy on an interface connected to the Internet is a security
risk because anyone on the Internet who finds the proxy could use it to hide their
source address. If you enable the proxy on such an interface make sure authentication
is required to use the proxy.

4. Go to Policy & Objects > Proxy Policyand select Create New and set the Explicit Proxy Type to FTP.

You can add multiple explicit FTP proxy policies.
5. Configure the policy as required to accept the traffic that you want to be processed by the explicit FTP proxy.

The source address of the policy should match client source IP addresses. The firewall address selected as the
source address cannot be assigned to a FortiGate interface. The Interface field of the firewall address must be
blank or it must be set to Any.

The destination address of the policy should match the IP addresses of FTP servers that clients are connecting to.
The destination address could be all to allow connections to any FTP server.

If Default Firewall Policy Action is set to Deny, traffic sent to the explicit FTP proxy that is not accepted by an
explicit FTP proxy policy is dropped. If Default Firewall Policy Action is set to Allow then all FTP proxy sessions
that don’t match a policy are allowed.

For example the following explicit FTP proxy policy allows users on an internal network to access FTP servers on
the Internet through the wan1 interface of a FortiGate unit.

Explicit Proxy Type FTP

Source Address Internal_subnet

Outgoing Interface wan1

Destination Address all

Schedule always

Action ACCEPT

The following explicit FTP proxy policy requires users on an internal network to authenticate with the
FortiGate unit before accessing FTP servers on the Internet through the wan1 interface.

Explicit Proxy Type FTP

Source Address Internal_subnet

Outgoing Interface wan1

Destination Address all

Action AUTHENTICATE

6. Select Create New to add an Authentication Rule and configure the rule as follows:
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Groups Proxy-Group

Source Users (optional)

Schedule always

7. Add security profiles as required and select OK.
8. You can add multiple authentication rules to apply different authentication for different user groups and users and

also apply different security profiles and logging settings for different users.
9. Select OK.

To enable the explicit FTP proxy - CLI:

1. Enter the following command to turn on the explicit FTP proxy. This command also changes the explicit FTP proxy
port to 2121.

config ftp-proxy explicit
set status enable
set incoming-port 2121

end

The default explicit FTP proxy configuration has sec-default-action set to deny and requires
you to add a security policy to allow access to the explicit FTP proxy.

2. Enter the following command to enable the explicit FTP proxy for the internal interface.
config system interface

edit internal
set explicit-ftp-proxy enable

end
end

3. Use the following command to add a firewall address that matches the source address of users who connect to the
explicit FTP proxy.

config firewall address
edit Internal_subnet

set type iprange
set start-ip 10.31.101.1
set end-ip 10.31.101.255

end

The source address for a ftp-proxy security policy cannot be assigned to a FortiGate unit interface.

4. Use the following command to add an explicit FTP proxy policy that allows all users on the internal subnet to use
the explicit FTP proxy for connections through the wan1 interface to the Internet.

config firewall proxy-policy
edit 0

set proxy ftp
set dstintf wan1
set scraddr Internal_subnet
set dstaddr all
set action accept
set schedule always

end

5. Use the following command to add an explicit FTP proxy policy that allows authenticated users on the internal
subnet to use the explicit FTP proxy for connections through the wan1 interface to the Internet.
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config firewall proxy-policy
edit 0

set proxy ftp
set dstintf wan1
set scraddr Internal_subnet
set dstaddr Fortinet-web-sites
set action accept
set schedule always
set groups <User group>
end

end

Restricting the IP address of the explicit FTP proxy
You can use the following command to restrict access to the explicit FTP proxy using only one IP address. The IP
address that you specify must be the IP address of an interface that the explicit FTP proxy is enabled on. You
might want to use this option if the explicit FTP proxy is enabled on an interface with multiple IP addresses.

For example, to require uses to connect to the IP address 10.31.101.100 to connect to the explicit FTP proxy:

config ftp-proxy explicit
set incoming-ip 10.31.101.100

end

Restricting the outgoing source IP address of the explicit FTP proxy
You can use the following command to restrict the source address of outgoing FTP proxy packets to a single IP
address. The IP address that you specify must be the IP address of an interface that the explicit FTP proxy is
enabled on. You might want to use this option if the explicit FTP proxy is enabled on an interface with multiple IP
addresses.

For example, to restrict the outgoing packet source address to 172.20.120.100:

config ftp-proxy explicit
set outgoing-ip 172.20.120.100

end

Example users on an internal network connecting to FTP servers on the Internet through
the explicit FTP with RADIUS authentication and virus scanning

This example describes how to configure the explicit FTP proxy for the example network shown below. In this
example, users on the internal network connect to the explicit FTP proxy through the Internal interface with IP
address 10.31.101.100. The explicit web proxy is configured to use port 2121 so to connect to an FTP server on
the Internet users must first connect to the explicit FTP proxy using IP address 10.31.101.100 and port 2121.

Example explicit FTP proxy network topology

In this example, explicit FTP proxy users must authenticate with a RADIUS server before getting access to the
proxy. To apply authentication, the security policy that accepts explicit FTP proxy traffic includes an identity
based policy that applies per session authentication to explicit FTP proxy users and includes a user group with the
RADIUS server in it. The identity based policy also applies UTM virus scanning and DLP.
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General configuration steps

This section breaks down the configuration for this example into smaller procedures. For best results, follow the
procedures in the order given:

1. Enable the explicit FTP proxy and change the FTP port to 2121.
2. Enable the explicit FTP proxy on the internal interface.
3. Add a RADIUS server and user group for the explicit FTP proxy.
4. Add a user identity security policy for the explicit FTP proxy.
5. Enable antivirus and DLP features for the identity-based policy.

Configuring the explicit FTP proxy - web-based manager

Use the following steps to configure the explicit FTP proxy from FortiGate web-based manager.

To enable and configure the explicit FTP proxy

1. Go to Network > Explicit Proxy > Explicit FTP Proxy Options and change the following settings:

Enable Explicit FTP Proxy Select.

Listen on Interface No change. This field will eventually show that the explicit web proxy is
enabled for the Internal interface.

FTP Port 2121

Default Firewall Policy
Action

Deny

2. Select Apply.

To enable the explicit FTP proxy on the Internal interface

1. Go to Network > Interfaces, edit the Internal interface and select Enable Explicit FTP Proxy.

To add a RADIUS server and user group for the explicit FTP proxy

1. Go to User & Device > RADIUS Servers.
2. Select Create New to add a new RADIUS server:

Name RADIUS_1

Primary Server Name/IP 10.31.101.200

Primary Server Secret RADIUS_server_secret

3. Go to User > User > User Groups and select Create New.

Name Explict_proxy_user_group

Type Firewall
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Remote groups RADIUS_1

Group Name ANY

4. Select OK.

To add a security policy for the explicit FTP proxy

1. Go to Policy & Objects > Addresses and select Create New.
2. Add a firewall address for the internal network:

Address Name Internal_subnet

Type Subnet

Subnet / IP Range 10.31.101.0

Interface Any

3. Go to Policy & Objects > Proxy Policyand select Create New.
4. Configure the explicit FTP proxy security policy.

Explicit Proxy Type FTP

Source Address Internal_subnet

Outgoing Interface wan1

Destination Address all

Action AUTHENTICATE

5. UnderConfigure Authentication Rules select Create New to add an authentication rule:

Groups Explicit_policy

Users Leave blank

Schedule always

6. Turn on Antivirus andWeb Filter and select the default profiles for both.
7. Select the default proxy options profile.
8. Select OK.
9. Make sure Enable IP Based Authentication is not selected and DefaultAuthentication Method is set to

Basic.
10. Select OK.

Configuring the explicit FTP proxy - CLI

Use the following steps to configure the example explicit web proxy configuration from the CLI.
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To enable and configure the explicit FTP proxy

1. Enter the following command to enable the explicit FTP proxy and set the TCP port that proxy accepts FTP
connections on to 2121.

config ftp-proxy explicit
set status enable
set incoming-port 2121
set sec-default-action deny

end

To enable the explicit FTP proxy on the Internal interface

1. Enter the following command to enable the explicit FTP proxy on the internal interface.
config system interface

edit internal
set explicit-ftp-proxy enable

end

To add a RADIUS server and user group for the explicit FTP proxy

1. Enter the following command to add a RADIUS server:
config user radius

edit RADIUS_1
set server 10.31.101.200
set secret RADIUS_server_secret

end

2. Enter the following command to add a user group for the RADIUS server.
config user group

edit Explicit_proxy_user_group
set group-type firewall
set member RADIUS_1

end

To add a security policy for the explicit FTP proxy

1. Enter the following command to add a firewall address for the internal subnet:
config firewall address

edit Internal_subnet
set type iprange
set start-ip 10.31.101.1
set end-ip 10.31.101.255

end

2. Enter the following command to add the explicit FTP proxy security policy:
config firewall proxy-policy

edit 0
set proxy ftp
set dstintf wan1
set srcaddr Internal_subnet
set dstaddr all
set action accept
set identity-based enable
set ipbased disable
set active-auth-method basic
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set groups <User group>
end

Testing and troubleshooting the configuration

You can use the following steps to verify that the explicit FTP proxy configuration is working as expected. These
steps use a command line FTP client.

To test the explicit web proxy configuration

1. From a system on the internal network start an FTP client and enter the following command to connect to the FTP
proxy:

ftp 10.31.101.100

The explicit FTP proxy should respond with a message similar to the following:

Connected to 10.31.101.100.
220 Welcome to Floodgate FTP proxy
Name (10.31.101.100:user):

2. At the prompt enter a valid username and password for the RADIUS server followed by a user name for an FTP
server on the Internet and the address of the FTP server. For example, if a valid username and password on the
RADIUS server is ex_name and ex_pass and you attempt to connect to an FTP server at ftp.example.com with
user name s_name, enter the following at the prompt:

Name (10.31.101.100:user):ex_name:ex_pass:s_name@ftp.example.com

3. You should be prompted for the password for the account on the FTP server.
4. Enter the password and you should be able to connect to the FTP server.
5. Attempt to explore the FTP server file system and download or upload files.
6. To test UTM functionality, attempt to upload or download an ECAR test file. Or upload or download a text file

containing text that would be matched by the DLP sensor.

For eicar test files, go to http://eicar.org.

Diagnose commands for WAN Optimization

The following get and diagnose commands are available for troubleshooting WAN optimization, web cache,
explicit proxy and WCCP.

get test {wad | wccpd} <test_level>
Display usage information about WAN optimization, explicit proxy, web cache, and WCCP applications. Use
<test_level> to display different information.

get test wad <test_level>
get test wccpd <test_level>

Variable Description

wad Display information about WAN optimization, web caching, the explicit web proxy, and
the explicit FTP proxy.
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Variable Description

wccpd Display information about the WCCP application.

Examples

Enter the following command to displayWAN optimization tunnel protocol statistics. The http tunnel and tcp
tunnel parts of the command output below shows that WAN optimization has been processing HTTP and TCP
packets.

get test wad 1
WAD manager process status: pid=113 n_workers=1 ndebug_workers=0

Enter the following command to display all test options:

get test wad

WAD process 82 test usage:
1: display process status
2: display total memory usage.
99: restart all WAD processes
1000: List all WAD processes.
1001: dispaly debug level name and values
1002: dispaly status of WANOpt storages
1068: Enable debug for all WAD workers.
1069: Disable debug for all WAD workers.
2yxx: Set No. xx process of type y as diagnosis process.
3: display all fix-sized advanced memory stats
4: display all fix-sized advanced memory stats in details
500000..599999: cmem bucket stats (599999 for usage)
800..899: mem_diag commands (800 for help & usage)
800000..899999: mem_diag commands with 1 arg (800 for help & usage)
80000000..89999999: mem_diag commands with 2 args (800 for help & usage)
60: show debug stats.
61: discard all wad debug info that is currently pending
62xxx: set xxxM maximum ouput buffer size for WAD debug. 0, set back to default.
68: Enable process debug
69: Disable process debug
98: gracefully stopping WAD process
9xx: Set xx workers(0: default based on user configuration.)

diagnose wad
Display diagnostic information about the WAN optimization daemon (wad).

diagnose wad console-log {disable | enable)
diagnose wad debug-url {disable | enable)
diagnose wad filter {clear | dport | dst | list | negate | protocol | sport | src | vd}
diagnose wad history {clear | list}
diagnose wad session {clear | list}
diagnose wad stats {cache | cifs | clear | crypto | ftp | http | list | mapi | mem |

scan | scripts | summary | tcp | tunnel}
diagnose wad user {clear | list}
diagnose wad tunnel {clear | list}1
diagnose wad webcache {clear | list} {10min | hour | day | 30days}
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Variable Description

console-log Enable or disable displaying WAN optimization log messages on the CLI console.

filter

Set a filter for listing WAN optimization daemon sessions or tunnels.

clear reset or clear the current log filter settings.

dport enter the destination port range to filter by.

dst enter the destination address range to filter by.

list display the current log filter settings

history Display statistics for one or more WAN optimization protocols for a specified period of
time (the last 10 minutes, hour, day or 30 days).

session Display diagnostics for WAN optimization sessions or clear active sessions.

stats Display statistics for various parts of WAN optimization such as cache statistics, CIFS
statistics, MAPI statistics, HTTP statistics, tunnel statistics etc. You can also clear
WAN optimization statistics and display a summary.

tunnel Display diagnostic information for one or all active WAN optimization tunnels. Clear all
active tunnels. Clear all active tunnels.

webcache Display web cache activity for the specified time period.

Example diagnose wad tunnel list

Enter the following command to list all of the running WAN optimization tunnels and display information about
each one. The command output shows 10 tunnels all created by peer-to-peer WAN optimization rules (auto-
detect set to off).

diagnose wad tunnel list

Tunnel: id=100 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=100 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=348 bytes_out=384

Tunnel: id=99 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=99 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=348 bytes_out=384

Tunnel: id=98 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=98 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
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bytes_in=348 bytes_out=384

Tunnel: id=39 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=39 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=1068 bytes_out=1104

Tunnel: id=7 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=7 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=8 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=8 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=5 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=5 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=4 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=4 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=1 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=1 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnel: id=2 type=manual
vd=0 shared=no uses=0 state=3
peer name=Web_servers id=2 ip=172.20.120.141
SSL-secured-tunnel=no auth-grp=
bytes_in=1228 bytes_out=1264

Tunnels total=10 manual=10 auto=0

Example diagnose wad webcache list

This following command displays the web caching stats for the last 10 minutes of activity. The information
displayed is divided into 20 slots and each slot contains stats for 30 seconds:

20 * 30 seconds = 600 seconds = 10 minutes

diagnose wad webcache list 10min
web cache history vd=0 period=last 10min
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The first 20 slots are for HTTP requests in the last 10 minutes. Each slot of stats has four numbers, which is the
total number of HTTP requests, the number of cacheable HTTP requests, the number of HTTP requests that are
processed by the web cache (hits), and the number of HTTP requests that are processed without checking the
web cache (bypass). There are many reasons that a HTTP request may bypass web cache.

total cacheable hits bypass
------------ ------------- ------------ -------------
36 10 3 1
128 92 1 10
168 97 2 3
79 56 0 3
106 64 5 3
180 118 6 11
88 53 7 3
80 43 4 4
107 44 9 2
84 12 0 2
228 139 52 10
32 2 0 5
191 88            13 7
135 25 40 3
48 10 0 8
193 13 7 7
67 31 1 2
109          35 24 6
117 36            10 5
22           0 0 4
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The following slots are for video requests in the last 10 minutes. Each slot has two numbers for each 30 seconds:
total number of video requests, and the number of video requests that are processing using cached data.

video total video hit
------------ -------------
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0
0 0

The following 20 slots are for traffic details in last 10 minutes. Each slot has four numbers for 30 seconds each.

--- LAN --- --- WAN ---
bytes_in bytes_out bytes_in bytes_out
------------ ------------- ------------ -------------
34360        150261 141086 32347
105408 861863 858501 100670
128359 1365919 1411849      127341
60103 602813 818075       59967
105867 1213192 1463736 97489
154961 1434784 1344911 158667
73967 370275 369847 70626
129327 602834 592399       123676
115719 663446 799445       111262
58151        724993 631721 59989
175681       2092925 1092556 166212
37805 33042         41528 37779
183686 1255118 1114646      172371
106125 904178 807152 81520
66147 473983        543507 66782
170451       1289530       1201639 165540
69196        544559        865370 68446
134142       579605 821430       132113
96895        668037        730633       89872
59576        248734 164002 59448

diagnose wacs
Display diagnostic information for the web cache database daemon (wacs).

diagnose wacs clear
diagnose wacs recents
diagnose wacs restart
diagnose wacs stats
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Variable Description

clear Remove all entries from the web cache database.

recents Display recent web cache database activity.

restart Restart the web cache daemon and reset statistics.

stats Display web cache statistics.

diagnose wadbd
Display diagnostic information for the WAN optimization database daemon (waddb).

diagnose wadbd {check | clear | recents | restart | stats}

Variable Description

check CheckWAN optimization database integrity.

clear Remove all entries from the WAN optimization database.

recents Display recent WAN optimization database activity.

restart Restart the WAN optimization daemon and reset statistics.

stats DisplayWAN optimization statistics.

diagnose debug application {wad | wccpd} [<debug_level>]
View or set the debug level for displaying WAN optimization and web cache-related daemon debug messages.
Include a <debug_level> to change the debug level. Leave the <debug_level> out to display the current
debug level. Default debug level is 0.

diagnose debug application wad [<debug_level>]
diagnose debug application wccpd [<debug_level>]

Variable Description

wad Set the debug level for the WAN optimization daemon.

wccpd Set the debug level for the WCCP daemon.

diagnose test application wad 2200
The debug level 2200 switches the debug to explicit proxy mode. You have to enter this debug level first. After
that you have to type the command again with a different debug level to check the different explicit proxy
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statistics. To list what each debug level shows, follow these steps in any FortiGate device:

1. Enable explicit proxy globally and in one interface, to start the wad process. If the wad process is not running, you
cannot list the options.

2. Once the wad process starts, type:

diagnose test application wad 2200
diagnose test application wad ///// Do not type any debug level value to list all the options.

This is the output you will get:

# diagnose test application wad 2200
Set diagnosis process: type=wanopt index=0 pid=114
# diagnose test application wad
WAD process 114 test usage:
1: display process status
2: display total memory usage
99: restart all WAD processes
1000: List all WAD processes
1001: dispaly debug level name and values
1002: dispaly status of WANOpt storages
1068: Enable debug for all WAD workers
1069: Disable debug for all WAD workers
2yxx: Set No. xx process of type y as diagnosis process
3: display all fix-sized advanced memory stats
4: display all fix-sized advanced memory stats in details
500000..599999: cmem bucket stats (599999 for usage)
800..899: mem_diag commands (800 for help & usage)
800000..899999: mem_diag commands with 1 arg (800 for help & usage)
80000000..89999999: mem_diag commands with 2 args (800 for help & usage)
60: show debug stats
61: discard all wad debug info that is currently pending
62xxx: set xxxM maximum ouput buffer size for WAD debug (0: set back to default)
68: Enable process debug
69: Disable process debug
98: gracefully stopping WAD process
20: display all listeners
21: display TCP port info
22: display SSL stats
23: flush SSL stats
24: display SSL mem stats
70: display av memory usage
71xxxx: set xxxxMiB maximum AV memory (0: set back to default)
72: toggle av memory protection
73: toggle AV conserve mode (for debug purpose)
90: set to test disk failure
91: unset to test disk failure
92: trigger a disk failure event
100: display explicit proxy settings
101: display firewall policies
102: display security profile mapping for regular firewall policy
103: display Web proxy forwarding server and group
104: display DNS stats
105: display proxy redirection scan stats
106: list all used fqdns
107: list all firewall address
110: display current web proxy users
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111: flush current web proxy users
112: display current web proxy user summary
113: display WAD fsso state
114: display HTTP digest stats
115: display URL patterns list of cache exemption or forward server
116: toggle dumping URL when daemon crashes
120: display Web Cache stats
121: flush Web Cache stats
122: flush idle Web cache objects
123: display web cache cache sessions
130: display ftpproxy stats
131: clear ftpproxy stats
132: list all current ftpproxy sessions
133: display all catched webfilter profiles
200: display WANopt profiles
201: display all peers
202: display video cache rules (patterns)
203: display all ssl servers
210: toggle disk-based byte-cache
211: toggle memory-based byte-cache
212: toggle cifs read-ahead
221: display tunnel protocol stats
222: flush tunnel protocol stats
223: display http protocol stats
224: flush http protocol stats
225: display cifs protocol stats
226: flush cifs protocol stats
227: display ftp protocol stats
228: flush ftp protocol stats
229: display mapi protocol stats
230: flush mapi protocol stats
231: display tcp protocol stats
232: flush tcp protocol stats
233: display all protocols stats
234: flush all protocols stats
240: display WAD tunnel stats
241: display tunnel compressor state
242: flush tunnel compressor stats
243: display Byte Cache DB state
244: flush Byte Cache DB stats
245: display Web Cache DB state
246: flush Web Cache DB stats
247: display cache state
248: flush cache stats
249: display memory cache state
250: flush memory cache stats
261yxxx: set xxx concurrent Web Cache session for object storage y
262yxxx: set xxxK(32K, 64K,...) unconfirmed write/read size per Web Cache object for

object storage y
263yxxxx: set xxxxK maximum ouput buffer size for object storage y
264yxx: set lookup lowmark (only if more to define busy status) to be xx for object

storage y
265yxxx: set xxxK maximum ouput buffer size for byte storage y
266yxxx: set number of buffered add requests to be xxx for byte storage y
267yxxxx: set number of buffered query requests to be xxxx for byte storage y
268yxxxxx: set number of concurrent query requests to be xxxxx for byte storage y
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Chapter 10 - FortiView

FortiView

This document provides a general guide to FortiView, the FortiOS log view tool, explaining its layout, features,
and its usefulness in everyday administrative scenarios. This document includes:

l Overview on page 1257 outlines the role FortiView plays in FortiOS and its overall layout. This section also
identifies which FortiGate platforms support the full FortiView features.

l FortiView consoles on page 1268 describes the various FortiView consoles available in FortiOS, including example
scenarios, in most cases.

l Reference on page 1285 explains reference information for the various consoles in FortiView, and describes the
assortment of filtering options, drilldown options, and columns available.

l Troubleshooting FortiView on page 1298 offers solutions to common technical issues experienced by FortiGate
users regarding FortiView.
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Purpose

FortiView is a comprehensive monitoring system for your network that integrates real-time and historical data into
a single view on your FortiGate. It can log and monitor threats to networks, filter data on multiple levels, keep
track of administrative activity, and more.

FortiView allows you to use multiple filters within the consoles, enabling you to narrow your view to a specific time
(up to 24 hours in the past), by user ID or local IP address, by application, and many more. For more on
FortiView's filtering options, see Filtering options on page 1286

FortiView can be used to investigate traffic activity, such as user uploads/downloads or videos watched on
YouTube, on a network-wide, user group, and individual-user level, with information relayed in both text and
visual format. FortiView makes it easy to get an actionable picture of your network's internet activity.

The degree to which information can be logged will depend on which FortiGate unit you have. For more
information, see Enabling FortiView on page 1258.
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What's new in FortiOS 5.6

The following section describes new FortiView features added to FortiOS 5.6.0, 5.6.1, 5.6.3, 5.6.4.

FortiOS 5.6.4
These features first appeared in FortiOS 5.6.4.

Increased visibility of interactivity in FortiView

Visual feedback has been added to mouse-over on FortiView charts, in order to increase visibility of interactivity
that already existed. Cursors have also been updated to display possible interactions.

Automatic synchronization of log display location

In previous versions, log display location could differ between Log & Report and FortiView, which could result in
empty log screens if the two were not synchronized. As of 5.6.4, both log viewers automatically pick the best
available log device. A different log device can be manually selected.

As a result, the associated CLI command log gui-display location has been removed.

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Support learning reports and FortiAnalyzer (415806)

Both backend and GUI have been updated to support learning reports from FortiAnalyzer.

Backend updates the query configure list; GUI updates learning report to use log display device setting.

Added support to FortiView to sort by application risk and browsing time (249666)

Added ability to sort applications by threat level and by browsing time so that admin can quickly see and prioritize
the riskier applications at the top of the list.

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

FortiView Dashboard Widget (434179)

A new widget type has been added to the FortiGate Dashboard, that displays compact FortiView data. Supported
FortiViews include Source, Destination, Application, Country, Interfaces, Policy, Wifi Client, Traffic Shaper,
Endpoint Vulnerability, Cloud User, Threats, VPN, Websites, Admin, and System. All usual visualizations are
supported.

Widgets can be saved directly to the Dashboard from a filtered page in FortiView, or configured in the CLI.
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Interface Categories (srcintfrole, etc) added to log data (434188)

In 5.6, logs and FortiView both sort log traffic into two interface categories: "Traffic from LAN/DMZ", and "Traffic
from WAN." For greater compatibility and troubleshooting of FortiAnalyzer and FortiCloud setups, interface
category fields that expose this information have been added to general log data in 5.6.1: srcintfrole and
dstintfrole for better backend control and monitoring.

FortiOS 5.6.0
These features first appeared in FortiOS 5.6.0.

Added Vulnerability score topology view (303786)

In Physical Topology and Logical Topology pages, there are two new views added: Vulnerability, and
Threat. Drill-downs in these menus will now include Vulnerability/Threat information. In Vulnerability view, device
bubbles are colored based on maximum vulnerability level, and bubble size is the vulnerability score. In Threat
view, device bubbles are colored based on maximum threat level, and bubble size is the threat score.

FortiView VPN tunnel map feature (382767)

The FortiView VPN page now displays VPN tunnel connections between devices, and offers more information
about tunnels and devices on drill-down.

Updated FortiView CSF topology pages (384188)

The FortiView Physical Topology and Logical Topology pages have been updated in 5.6.0 to reorganize and
clarify larger deployments with servers and multi-directional traffic.

Historical FortiView includes FortiAnalyzer (387423)

Data from associated FortiAnalyzer devices can now be selected as a log display option for Historical FortiView.

FortiView menu reorganization (399713)

The order of FortiView pages has been reorganized in 5.6.0 based on the source interface of data being
displayed:

l Topology
l Traffic from LAN/DMZ
l Traffic from WAN
l All Segments

Data Exchange with FortiAnalyzer (393891)

Rather than sending all CSF information via log messages, FortiGate and FortiAnalyzer will now directly pass
CSF information (tree, interface roles, user devices, HA members), if the FAZ responds to notices that are sent
when the data has changed.

Google Maps Integration

FortiView now uses Google Maps to display location-related information. In this release the first view to use
Google maps this component is the FortView VPN page. All current VPNs can be viewed on a fully scalable
Google world map.
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FortiView usability and organization updates (306247)

Several organization changes have been made to make the FortiView menu order less cluttered, and more
intuitive.

l WiFi ClientMonitor is now in FortiView, but is hidden when there is no managed FortiAP or WiFi Radio.
l Country view has been merged into Destinations view.
l Failed Authentication and Admin Login views have been merged into System Events view.
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Overview

This section provides an overview of FortiView, its interface, and options, including the following:
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Enabling FortiView
By default, FortiView is enabled on FortiGates running FortiOS firmware version 5.2 and above. You will find the
FortiView consoles in the main menu. However, certain options will not appear unless the FortiGate hasDisk
Logging enabled.

Only certain FortiGate models support Disk Logging. A complete list of FortiGate platforms that support Disk
Logging is provided in the matrix below.

To enable Disk Logging

1. Go to Log & Report > Log Settings and select the checkbox next to Disk.
2. Apply the change.

To enable Disk Logging - CLI

config log disk setting
set status enable

end

FortiView Feature Support - Platform Matrix
Note that the following table identifies three separate aspects of FortiView in FortiOS 5.2.3:

l Basic feature support
l Historical Data
l Disk Logging

Platform Basic Feature Support Disk Logging Historical Data *

FG/FWF-20C Series a

FG/FWF-30D/40C Series a

FG/FWF-60C Series a

FG/FWF-60D Series a

FGR-60D a

FG-60D a

FG/FWF-80C Series a

FG-80D a a 1 hour

FG/FWF-90D Series a a 1 hour

FG/FWF-92D Series a
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Platform Basic Feature Support Disk Logging Historical Data *

FG-110C a

FG-111C a CLI 1 hour

FG-100D Series a a 24 hours

FG-200B Series a # # (24 hours)

FG-200D Series a a 24 hours

FG-310B a # (24 hours)

FG-311B a # (24 hours)

FG-300C a a 24 hours

FG-300D a a 24 hours

FG-500D a a 24 hours

FG-620B a # # (24 hours)

FG-621B a # # (24 hours)

FG-600C a a 24 hours

FG-800C a a 24 hours

FG-1000D a a 7 hours, 24 hours

FG-1500D a a 7 hours, 24 hours

FG-1240B a a 24 hours

FG-3016B a # # (24 hours)

FG-3040B a CLI 24 hours

FG-3140B a CLI 24 hours

FG-3240C a CLI 24 hours

FG-3600C a CLI 24 hours

FG-3700D/DX a CLI 7 hours, 24 hours

FG-3810A a # # (24 hours)
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Platform Basic Feature Support Disk Logging Historical Data *

FG-3950B a #, CLI # (24 hours)

FG-3951B a #, CLI # (24 hours)

FG-5001A a #, CLI # (24 hours)

FG-5001B a CLI 24 hours

FG-5001C a CLI 24 hours

FG-5001D a CLI 24 hours

FG-5101C a CLI 24 hours

FS-5203B a CLI

a =Default support.
# = Local storage required.

* Refer to section on Historical Data below.

Basic feature support

FortiView's consoles give insight into your user's traffic, not merely showing which users are creating the most
traffic, but what sort of traffic it is, when the traffic occurs, and what kind of threat the traffic may pose to the
network.

FortiView basic feature support consists of the following consoles:

l Sources
l Destinations
l Interfaces
l Policies
l All Sessions
l Applications

The complete array of features in FortiView requires disk logging enabled (see below). It includes those consoles
listed above as well as the following:

l WiFi Clients
l Cloud Applications
l Web Sites
l Threats
l VPN

Historical Data

Not all consoles have the same available historical data options, depending on whether or not your traffic is
locally stored.
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Below is a table showing which features are available for units using local storage, including the historical data
options.

Only FortiGate models 100D and above support the 24 hour historical data.

Features With Local Storage Without Local Storage

Now 5 min 1 hr 24 hr * Now 5 min 1 hr 24 hr

Sources a a a a a

Destinations a a a a a

Interfaces a a a a

Policies a a a a

All Sessions a a a a a

Applications a a a a a

WiFi Clients a a a

Cloud Applications a a a a a

Web Sites a a a a

Threats a a a

Threat Map a a

FortiSandbox a a a

System Events a a a

VPN a a a

* Not available for desktop models with SSD.

7-day time display

Asmentioned previously, certain models support 7-day time display. These models are listed below:

l FortiGate 1000D
l FortiGate 1500D
l FortiGate 3700DX
l FortiGate 3700D

The option for 7-day time display, however, can only be configured in the CLI using the following command:
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config log setting
set fortiview-weekly-data {enable|disable}

end

Disk Logging

Only certain FortiGate models support Disk Logging (see above).

To enable Disk Logging, go to Log & Report > Log Settings, and select the checkbox next to Disk and apply
the change. Some devices will require disk logging to be enabled in the CLI, using the following command:

config log disk setting
set status enable

end

Configuration Dependencies
Most FortiView consoles require the user to enable several features to produce data. The following table
summarizes the dependencies:

Feature Dependencies (Realtime) Dependencies (Historical)

Sources None, always supported Traffic logging enabled in policy

Destinations None, always supported Traffic logging enabled in policy

Interfaces None, always supported Disk logging enabled

Traffic logging enabled in policy

Policies None, always supported Disk logging enabled

Traffic logging enabled in policy

All Sessions None, always supported Traffic logging enabled in policy

Applications None, always supported Disk logging enabled

Traffic logging enabled in policy

Application control enabled in policy

WiFi Clients SSID must be in Tunnel mode Disk logging enabled

Traffic logging enabled in policy

SSID must be in Tunnel mode
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Feature Dependencies (Realtime) Dependencies (Historical)

Cloud Applications Not supported Disk logging enabled

Application control enabled in policy

SSL "deep inspection" enabled in policy

Deep application inspection enabled in
application sensor

Extended UTM log enabled in application
sensor

Web Sites Disk logging enabled

Web Filter enabled in policy

"web-url-log" option enabled in Web
Filter profile

Disk logging enabled

Web Filter enabled in policy

"web-url-log" option enabled in Web Filter
profile

Threats Not supported Disk logging enabled

Traffic logging enabled in policy

Threat weight detection enabled

Threat Map Disk logging enabled

Traffic logging enabled in policy

Threat weight detection enabled

Disk logging enabled

Traffic logging enabled in policy

Threat weight detection enabled

FortiSandbox Not supported
Disk logging enabled

Traffic logging enabled in policy

System Events Not supported Disk logging enabled

VPN Not supported
Disk logging enabled

Traffic logging enabled in policy
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FortiView interface
FortiView lets you access information about the traffic activity on your FortiGate, visually and textually. FortiView
is broken up into several consoles, each of which features a top menu bar and a graph window, as seen in the
following image:

FortiView Application console sorted by Sessions (Blocked/Allowed)

The top menu bar features:

l a Refresh button, which updates the data displayed,
l a Filter button, for filtering the data by category,
l a Settings button (containing additional viewing settings and a link to the Threat Weight menu).
l a drop-down menu of different views:

l Time Display (options: now, 5 minutes, 1 hour, or 24 hours),
l Table View
l Timeline View
l Bubble Chart 1

l Country Map
1 For information on the Bubble Chart, refer to Bubble Chart Visualization on page 1265.

Certain views are only available in specific consoles.

The FortiView graph

The graph window can be hidden using the X in the top right corner, and re-added by selecting Show Graph. To
zoom in on a particular section of the graph, click and drag from one end of the desired section to the other. This
will appear in the Time Display options as a Custom selection. The minimum selection size is 60 seconds.
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Only FortiGate models 100D and above support the 24 hour historical data.

Bubble Chart Visualization

Notes about the Bubble Chart:

l It is possible to sort on the Bubble Chart using the Sort By: dropdown menu.
l The size of each bubble represents the related amount of data.
l Place your cursor over a bubble to display a tool-tip with detailed info on that item.
l You can click on a bubble to drilldown into greater (filtered) detail.
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Links created between FortiView and View/Create Policy

The Policy column in FortiView consoles and the Log Viewer pages includes a link, which navigates to the IPv4
or IPv6 policy list and highlights the policy.

Right-clicking on a row in FortiView or the Log Viewer has menu items forBlock Source, Block Destination
andQuarantine Sourcewhere appropriate columns are available to determine these values. When multiple
rows are selected, the user will be prompted to create a named Address Group to contain the new addresses.

When the user clicksBlock Source orBlock Destination they are taken to a policy creation page with enough
information filled in to create a policy blocking the requested IP traffic.

The policy page will feature an informational message block at the top describing the actions that will be taken.
Once the user submits the form, the requisite addresses, groups and policy will be created at once.

If the user clicks onQuarantine User then they will be prompted for a duration. They may also check a box for a
Permanent Ban. The user can manage quarantined users underMonitor > Quarantine Monitor.

Visualization support for the Admin Logins page

A useful chart is generated for Admin login events under FortiView > Admin Logins. You can view the
information in either Table View or Timeline View (shown below). In Timeline View, each line represents on
administrator, with individual sessions indicated per administrator line. When you hover over a particular timeline,
detailed information appears in a tooltip.

Realtime visualization

To enable realtime visualization:

1. Click on the Settings icon next to the upper right-hand corner and select Auto update realtime visualizations.
An option is displayed to set the Interval (seconds). The maximum value is 300.

2. Enter a desired Interval and clickApply.

Accelerated sessions

When viewing sessions in the All Sessions console, information pertaining to NP4/ NP6 acceleration is now
reflected via an appropriate icon in the table. The tooltip for the icon includes the NP chip type and its total
number of accelerated sessions.

Filtering on accelerated sessions

You can filter the console on 'FortiASIC' ('Accelerated' versus 'Not Accelerated') sessions.
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WHOIS Lookup anchor for public IPv4 addresses

AReverse IP lookup is possible using the WHOIS lookup icon available when you mouse over a public IP address
in a FortiView log. If you left-click on the lookup icon, a new tab is opened in your browser for
www.networksolutions.com, and a lookup is performed on the selected IP address (this option persists after
drilling down one level in FortiView).
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FortiView consoles

This section describes the following log filter consoles available in FortiView:

l Sources on page 1269 displays detailed information on the sources of traffic passing through the FortiGate, and the
section covers how you can investigate an unusual spike in traffic to determine which user is responsible.

l Destinations on page 1270 displays detailed information on user destination-accessing through the use of drill down
functionality.

l Applications on page 1271 displays Applications used on the network that have been recognized by Application
Control, and this section shows how you can view what sort of applications individual employees are using.

l Cloud Applications on page 1272 displaysWeb/Cloud Applications used on the network, and this section shows
how you can drill down to access detailed data on cloud application usage, e.g. YouTube.

l Web Sites on page 1273 displays websites visited as part of network traffic that have been recognized byWeb
Filtering, and this section shows how you can investigate instances of proxy avoidance, which is the act of
circumventing blocks using proxies.

l Threats on page 1274 monitors threats to the network, both in terms of their Threat Score and Threat Level.
l WiFi Clients on page 1275 displays a list of all the devices connected to the WLAN.
l "Traffic Shaping" on page 1276 displays a list of existing Traffic Shapers, detailing their bandwidth use and which

traffic is being shaped by each shaper.
l System Events on page 1277 displays security events detected by FortiOS, providing a name and description for

the events, an assessment of the event's severity level, and the number of instances the events were detected.
l VPN on page 1278 displays how users can access information on any VPNs associated with their FortiGate.
l "Endpoint Vulnerability" on page 1279 displays a list of Vulnerability events detected by the FortiGate on networked

devices, along with links to further vulnerability information and databases.
l Threat Map on page 1280 provides a geographical display of threats, in realtime, from international sources as they

arrive at your FortiGate.
l Policies on page 1281 displays what policies are in affect on your network, what their source and destination

interfaces are, how many sessions are in each policy, and what sort of traffic is occurring.
l Interfaces on page 1282 displays the number of interfaces connected to your network, how many sessions there are

in each interface, and what sort of traffic is occurring.
l FortiSandbox on page 1283 displays FortiSandbox activity. FortiSandbox detects and analyzes advanced attacks

designed to bypass traditional security defenses, and has a wide array of features that allow it to prevent future
attacks from occurring again.

l All Sessions on page 1284 displays complete information on all FortiGate sessions, with the ability to filter sessions
by port number and application type.
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Sources
The Sources console provides information about the sources of traffic on your FortiGate unit.

This console can be filtered by Country, Destination Interface, Policy, Result, Source, and Source Interface. For
more on filters, see Filtering options.

Specific devices and time periods can be selected and drilled down for deep inspection.

Scenario: Investigating a spike in traffic

A system administrator notices a spike in traffic and wants to investigate it. From the Sourceswindow, they can
determine which user is responsible for the spike by following these steps:

1. Go to FortiView > Sources.
2. In the graph display, click and drag across the peak that represents the spike in traffic.
3. Sort the sources by bandwidth use by selecting the Bytes (Sent/Received) header.
4. Drill down into whichever source is associated with the highest amount of bandwidth use by double-clicking it.

From this screen, you have an overview of that source's traffic activity.
5. Again, in either the Applications orDestinations view, select the Bytes (Sent/Received) header to sort by

bandwidth use.
6. Double-click the top entry to drill down to the final inspection level, from which you can access further details on

the application or destination, and/or apply a filter to prohibit or limit access.

Only FortiGate models 100D and above support the 24 hour historical data.
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Destinations
The Destinations console provides information about the destination IP addresses of traffic on your FortiGate
unit, as well as the application used. You can drill down the displayed information, and also select the device and
time period, and apply search filters.

This console can be filtered by Country, Destination Interface, Destination IP, Policy, Result, and Source
Interface. For more on filters, see Filtering options.

Scenario: Monitoring destination data

The Destinations console can be used to access detailed information on user destination-accessing through the
use of the console's drilldown functionality. In this scenario, the console is used to find out more about a particular
user's Facebook usage patterns over a 24-hour period:

1. Go to FortiView > Destinations.
2. Select 1 hour from the Time Display options at the top right corner of the console.
3. The easiest way to locate most destinations is to scan the Applications column for the name of the application.

Once the session containing Facebook has been located, double-click it to access the Destination summary
window.

4. Locate Facebook in the Applications column and double-click it to view the Facebook drilldown page. From here,
detailed information regarding the user's Facebook session can be accessed.

Only FortiGate models 100D and above support the 24 hour historical data.
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Applications
The Applications console provides information about the applications being used on your network.

This console can be filtered by Application, Country, Destination Interface, Policy, Result, and Source Interface.
For more on filters, see Filtering options.

Specific devices and time periods can be selected and drilled down for deep inspection.

In order for information to appear in the Applications console, Application Control
must be enabled in a policy.

Scenario: Viewing application usage

Amanager is interested in the office internet habits of their employees:

1. Go to FortiView > Applications, to view the list of applications accessed by the users on your network. Use the
time-frame options to view what applications were used in those time periods (from now, 5 minutes, 1 hour, or 24
hours).

2. From Sessions (Blocked/Allowed) and Bytes (Sent/Received), you can see how much traffic has been
generated. Click these columns to show the traffic in descending order.

3. You notice that a social media application has created the most traffic of all the applications, and so it's at the top
of the list. Drill down into the application by double-clicking or right-clicking and select Drill Down to Details.

4. You are directed to a summary page of the social media application. From here, you can see which specific user
has made the most use of the application.

Only FortiGate models 100D and above support the 24 hour historical data.
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Cloud Applications
The Cloud Applications console provides information about the cloud applications being used on your network.
This includes information such as:

l The names of videos viewed on YouTube (visible by hovering the cursor over the session entry)
l Filed uploaded and downloaded from cloud hosting services such as Dropbox
l Account names used for cloud services

Two different views are available for the Cloud Applications: Applications and Users (located in the top menu
bar next to the time periods). Applications shows a list of the programs being used. Users shows information
on the individual users of the cloud applications, including the username, if the FortiGate was able to view the
login event.

This console can be filtered by Cloud Application and Result. For more on filters, see Filtering options.

In order for information to appear in the Cloud Applications console, an application
control profile (that has Deep Inspection of Cloud Applications turned on) must be
enabled in a policy, and SSL Inspection must use deep-inspection.

Scenario: Viewing cloud application usage data

From the Cloud Applications console, users can drill down to access detailed data on cloud application usage
data. In this scenario, the console is used to determine the network's most frequent user of YouTube over a 24-
hour period, and find out more about their usage patterns.

1. Go to FortiView > Cloud Applications.
2. Select Applications view from the top menu bar if it is not already selected.
3. Select 24 Hours from the Time Display options.
4. Find YouTube under the Application column and double-click it (or right-click and select Drill down for

details...). This will open the YouTube stats window.
5. To determine the user who has accessed YouTube the most frequently, sort the column entries bySessions by

selecting the column header of the same name.
6. Double-click (or right-click and select Drill down for details...) the top-bandwidth YouTube user to view detailed

stats, including the names of videos watched by the user and the date and time each video was accessed.

Only FortiGate models 100D and above support the 24 hour historical data.
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Web Sites
TheWeb Sites console lists the top allowed and top blocked web sites. You can view information by domain or
by FortiGuard categories by using the options in the top right corner. Each FortiGuard category can be selected in
order to see a description of the category and several example sites, with content loaded from FortiGuard on
demand.

This console can be filtered by Domain and Result. For more on filters, see Filtering options.

In order for information to appear in theWeb Sites console, web filtering must be
enabled in a policy, with FortiGate Categories enabled.

Scenario: Investigating an instance of Proxy Avoidance

In this scenario, the Categories view will be used to investigate an instance of Proxy Avoidance, one of the
Categories recognized by FortiOS. Proxy Avoidance denotes the use of a proxy site in order to access data that
might otherwise be blocked by the server.

1. Go to FortiView > Web Sites to open the Web Sites console.
2. Select Categories from the top bar menu to enter Categories view.
3. Scan the Categories column and locate the instance of Proxy Avoidance, then double-click it to enter its drilldown

screen.

Only FortiGate models 100D and above support the 24 hour historical data.
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Threats
The Threats console lists the top users involved in incidents, as well as information on the top threats to your
network.

The following incidents are considered threats:

l Risk applications detected by application control
l Intrusion incidents detected by IPS
l Malicious web sites detected by web filtering
l Malware/botnets detected by antivirus

This console can be filtered by Country, Destination Interface, Policy, Result, Security Action, Source Interface,
Threat, and Threat Type. For more on filters, see Filtering options.

In order for information to appear in the Threats console, Threat Weight Tracking
must be enabled.

Scenario: Monitoring Threats to the Network

Some users have high Threat Scores. The Threats console can be used to view all threats and discover why such
high scores are being shown:

1. Go to FortiView > Threats. In the graph display, click and drag across the peak that represents the spike in
threat score.

2. Sort the threats by score or level by selecting the Threat Score (Blocked/Allowed or the Threat Level headers
respectively.

3. You see that a specific threat's Threat Level is at Critical. Drill down into the threat by double-clicking or right-
clicking and select Drill down to details.

4. From this summary page, you can view the source IPs and the number of sessions that came from this threat.
Double-click on one of them.

5. The following page shows a variety of statistics, including Reference. The URL next to it will link you to a
FortiGuard page where it will display the description, affected products, and recommended actions, if you are not
familiar with the particular threat.

Only FortiGate models 100D and above support the 24 hour historical data.
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WiFi Clients
TheWiFi Clients console shows a list of all the devices connected to the WLAN. The type of device, source,
number of sources blocked and allowed, and bytes sent and received are displayed. The source's Service Set
Identifier (SSID) is also displayed in the Source SSID column. An SSID is a case sensitive, 32 character
alphanumerical identifier that acts as a password when a mobile device tries to connect to the WLAN.

This console can be filtered by AP, Device Type, Result, Source Device, Source IP, Source SSID, and User. For
more on filters, see Filtering options.

Scenario: Determining the threat risk of an individual WiFi client

In this scenario,the administrator will use the WiFi Clients FortiView console to determine the risk levels
associated with an individual WiFi client, and then drilldown into that client to determine where the risk originates
and who might be the offending user/IP.

1. Go to FortiView > WiFi Clients and view the device list table.
2. Double-click on a device to filter on that source.
3. Under the Risk column, identify the items that present the greatest risk (using the Applications, Destinations,

Threats, and/or Sessions tabs, for example).
4. Right-click these items for further action.
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Traffic Shaping
The Traffic Shaping console provides information about FortiGate Traffic Shapers that are currently in effect.
This console can be filtered by Traffic Shaper Name. For more on filters, see Filtering options.

A number of columns available in FortiView are only available in Traffic Shaping. For example, the Shaper
column displays the name of the Shaper, which can be used to monitor the traffic being shaped by Bytes Sent,
Received, and Dropped, so that bandwidth patterns and Shaper effectiveness can be analyzed.

Only FortiGate models 100D and above support the 24 hour historical data.
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System Events
The System Events console lists security events detected by FortiOS, providing a name and description for the
events, an assessment of the event's severity level (Alert, Critical, Emergency, Error, orWarning), and the
number of instances the events were detected.

Two other FortiView pages from 5.4 have been wrapped into the System Events page as of 5.6: Admin
Logins, and Failed Authentication.

This console can be filtered by Event Name, Result, and Severity. For more on filters, see Filtering options on
page 1286.

Scenario: Investigate network security events

System Events can be used in conjunction with All Sessions to see what network security events took place, and
specifically see what action was taken upon their detection:

1. Go to FortiView > System Events to see what and how many network events have taken place, as well as how
severe they are in terms of the threat they pose to the network.

2. You see that a particular event has warranted a severe rating, and has allowed traffic to bypass the firewall. Note
when the event took place, and go to FortiView > All Sessions, to see more information pertaining to the
security event.

3. From this console, you can determine the system event's source, how much traffic was sent and received, and the
security action taken in response to this security event. These actions differ, depending upon the severity of the
security event. See the entry for Security Action in Columns displayed on page 1291.

Only FortiGate models 100D and above support the 24 hour historical data.
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VPN
From the VPN console, users can access information on any VPNs associated with their FortiGate. From the
initial window, a list of all the associated VPNs is provided, along with general information, such as number of
user connections and VPN type. By double-clicking on an individual VPN (or right-clicking and selecting Drill
down for details...), users can access more specific data on that VPN.

Logs in the VPN console can be sorted by number of connections, last connection time, or data sent/received by
selecting the column headers.

This console can be filtered by Result, User Name, and VPN Type. For more on filters, see Filtering options on
page 1286.

Certain dashboard options will not appear unless your FortiGate has Disk Logging
enabled.

Furthermore, only certain FortiGate models support Disk Logging — refer to the
FortiView Feature Support - Platform Matrix on page 1258 for more information.

To enable Disk Logging, go to Log & Report > Log Settings, and select the
checkbox next to Disk and apply the change.

Scenario: Investigating VPN user activity

The VPN console can be used to access detailed data on VPN-user activity via the use of the drill down windows.
In this scenario, the administrator looks into the usage patterns of the IPsec user who has most frequently
connected to the network.

1. Go to FortiView > VPN to view the VPN console.
2. Select the Connections column header to sort the entries by number of connections to the network.
3. Locate the top user whose VPN Type is ipsec and double-click the entry to enter that user's drill down screen.
4. To get the most representative data possible, sort the entries by bandwidth use by selecting the Bytes

(Sent/Received) column header. Double-click the top entry to enter the drill down window for that connection
instance.
From this screen, the administrator can find out more about the specific session, including the date/time of
access, the XAuth (Extensible Authentication) User ID, the session's Tunnel ID, and more.

Only FortiGate models 100D and above support the 24 hour historical data.
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Endpoint Vulnerability
The Endpoint Vulnerability console lists the top devices and vulnerabilities detected, organized either by
frequency or risk level.

This console can be filtered by Vulnerabilty Name, Severity, Vulnerability Category, CVE-ID, or Host Count. For
more on filters, see Filtering options.

The Vulnerabilities detected by the FortiGate use definitions created by FortiGuard, and every vulnerability in
FortiView contains a link to the respective FortiGuard Labs documentation page (under the 'Vulnerability ID'
column) and the Common Vulnerabilities and Exposures documentation page (under the 'CVE-ID' column.)

Scenario: Monitoring Vulnerabilities on the Network

When a vulnerability appears in log data, you can use the FortiView page to see more information about it. The
Endpoint Vulnerability console can be used to view and track all historical vulnerabilities:

1. Go to FortiView > Endpoint Vulnerability. In the upper right, select Vulnerability.
2. Sort the threats by frequency by selecting the Host Count header.
3. You see that a frequent vulnerability's Severity is at Critical. Drill down into the threat by double-clicking or right-

clicking and select Drill down to details.
4. From this summary page, you can view the source IPs and devices on which this vulnerability was detected, and

also the Scan Time. Double-click on one of them.
5. The chart will be filtered to display the specific Endpoint and Vulnerability, offering more granular data about the

vulnerability, including its Category and the FortiClient ID of the device. You can access the CVE and FortiGuard
links from this page to learn more.

Only FortiGate models 100D and above support the 24 hour historical data.
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Threat Map
The Threat Map console displays network activity by geographic region. Threats from various international
destinations will be shown, but only those arriving at your destination, as depicted by the FortiGate. You can
place your cursor over the FortiGate's location to display the device name, IP address, and the city
name/location.

A visual lists of threats is shown at the bottom, displaying the location, severity, and nature of the attacks. The
color gradient of the darts on the map indicate the traffic risk, where red indicates the more critical risk.

Unlike other FortiView consoles, this console has no filtering options, however you can click on any country to drill
down into greater (filtered) detail.

Only FortiGate models 100D and above support the 24 hour historical data.

Scenario: Investigate various international threats

The Threat Map console can be used to regionalize areas that you are more interested in, and disregard regions
that you are not interested in:

1. Go to FortiView > Threat Map to see a real-time map of the globe. This will show various incoming threats from
multiple destinations around the world, depending upon where the FortiGate is placed on the map.

2. You are not interested with threats that are being sent to Eastern Europe, however you are concerned with threats
that may be sent to a city in North America. Click and drag the FortiGate to the approximate location where you
would like to monitor the incoming threats.

3. To see which countries are sending the more severe threats to your region/location, either see where the red darts
are coming from, or check the visual lists of threats at the bottom.
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Policies
The Policies console shows what policies are in affect on your network, what their source and destination
interfaces are, how many sessions are in each policy, and what sort of traffic is occurring, represented in bytes
sent and received.

This console can be filtered by Country, Destination Interface, Destination IP, Policy, Source, Source Device, and
Source Interface. For more on filters, see Filtering options.

Only FortiGate models 100D and above support the 24 hour historical data.

Scenario: Investigate which policies are in effect

You can click on policy IDs to drill down to the policy list and see what policy's are in effect for specific interfaces,
how many sessions have occurred, how many of those with the policy have been blocked, and more:

1. Go to FortiView > Policies, and double-click on a policy ID to drill down.
2. You will be redirected to a summary screen of the policy ID. From here you can view the source IP of where the

policy has been used, what source interface has been using the particular policy, and to verify what sort of threat
scores have been measured, both blocked and allowed.
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Interfaces
The Interfaces console lists the total number of interfaces connected to your network, how many sessions there
are in each interface, and what sort of traffic is occurring, represented in both bytes sent and received, and the
total bandwidth used.

This console can be filtered by Country, Destination Interface, Destination IP, Policy, Result, Source, and Source
Interface. For more on filters, see Filtering options.

Only FortiGate models 100D and above support the 24 hour historical data.

Scenario: Investigate traffic spikes per user

The wan1 interface is showing a higher amount of traffic than usual. A system administrator uses the console to
inspect which user (as represented by an IP address) is creating the spike in traffic:

1. Go to FortiView > Interfaces and double-click on wan1, or right click and select Drill Down to Details....
2. The console will drill down to a summary page of wan1, showing how many bytes are being sent and received,

how much bandwidth is being used, and how many sessions are currently using this interface. You see the
IP address of the user that is showing the most amount of traffic under Source.

3. You can further drill down to see the IP destination, the device, and the applications being used, and other
options.
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FortiView consoles

FortiSandbox
The FortiSandbox console detects and analyzes advanced attacks designed to bypass traditional security
defenses, and has a wide array of features that allow it to prevent future attacks from occurring again.

This console can be filtered by Checksum, File Name, Source, Status, and User Name. For more on filters, see
Filtering options.

Only FortiGate models 100D and above support the 24 hour historical data.
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FortiView consoles

All Sessions
The All Sessions console provides information about all FortiGate traffic. This console can be filtered by
Application, Country, Destination Interface, Destination IP, Destination Port, NAT Source IP, NAT Source Port,
Policy, Protocol, Source, Source Interface, Source IP, and Source Port. For more on filters, see Filtering options.

This console has the greatest number of column options to choose from. To choose which columns you wish to
view, select the column settings cog at the far right of the columns and select your desired columns. They can
then be clicked and dragged in the order that you wish them to appear.

A number of columns available in FortiView are only available in All Sessions. For example, the Action column
displays the type of response taken to a security event. This function can be used to review what sort of threats
were detected, whether the connection was reset due to the detection of a possible threat, and so on. This would
be useful to display alongside other columns such as the Source, Destination, and Bytes (Sent/Received)
columns, as patterns or inconsistencies can be analyzed.

Similarly, there are a number of filters that are only available in All Sessions, one of which is Protocol. This
allows you to display the protocol type associated with the selected session, e.g. TCP, FTP, HTTP, HTTPS, and
so on.

Scenario: Filtering sessions by port number and application type

From the All Sessions console, a wide variety of filters can be applied to sort the session data. In this example,
the All Sessions filters will be used to locate a specific user's recent Skype activity.

1. Go to FortiView > All Sessions.
2. Select now from the Time Display options if it is not already selected.
3. Select the Filter button, then select Applications. This will open a drop-down menu listing the applications that

appear in the master session list. From this list, locate and select Skype, or type "Skype" into the Search Bar and
hit Enter. This will filter the session list to only feature Skype usage.

4. Select the Filter button again, then select Destination Port from the drop-down menu, then locate and select
the desired port number. This will add a second filter which will restrict the results to presenting only the Skype
data associated with that port number.

Only FortiGate models 100D and above support the 24 hour historical data.
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Reference

Reference

This section consists of reference information for the various consoles in FortiView. Each console has an
assortment of filtering options, drilldown options, and columns that can be displayed. Since many of these
options and columns persist through each console, the entire list of options and their descriptions is included
below. Attempts have been made to identify the instances where an option or column is only available to a
particular console.

This section includes:
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Filtering options
When you select the Add Filter button, a drop-down list appears with a list of available filtering options.
Available options differ based on which console is currently being viewed. The following table explains all of the
available filtering options:

Filter option Description

Accelerated Sessions You can filter the console on 'FortiASIC' ('Accelerated' versus 'Not
Accelerated') sessions.

AP Filter by Access Point (AP) identification number.

Application Filter by application name.

Checksum Filter by checksum value. Checksums are reference digits used to
represent the correct datasum of a packet in order to detect errors.

Cloud Application Filter by cloud application name.

Note: This filter is only available in the Cloud Applications console.

Country Filter by the country from which the source accessed the server.

Destination Interface Filter by the interface type used by the destination user, e.g. wan1.

Destination IP Filter by the IP address used by the destination.

Destination Port Filter by the port used by the destination.

Note: This filter is only available in the All Sessions console,(viewing the
now time display).

Domain Filter by domain name.

Note: This filter is only available in theWeb Sites console.

Event Name Filter by security event name.

Note: This filter is only available in the System Events console.

File Name Filter by file name.

Note: This filter is only available in the FortiSandbox console.

Login Type Filter by type of login (eg. WEP) associated with the displayed
authentication attempt.

Note: This filter is only available in the Failed Authentications console.
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Filter option Description

NAT Source IP Filter by the NAT-translated source IP address.

Note: This filter is only available in the All Sessions console,(viewing the
now time display).

NAT Source Port Filter by the NAT-translated source interface.

Note: This filter is only available in the All Sessions console,(viewing the
now time display).

Policy Filter by the policy identification number.

Protocol Filter by the protocol used by the source, e.g. tcp or udp.

Note: This filter is only available in the All Sessions console,(viewing the
now time display).

Result Filter by the result of whatever security action was taken by FortiOs in the
selected session, eg. Accept (all).

Security Action Filter by the type of response taken to the security event. The types of
possible actions are as follows:

Allowed:No threat was detected and the connection was let through.

Blocked: A threat was detected and the connection was not let through.

Reset: A possible issue was detected and the connection was reset.

Traffic Shape: Some data packets may have been delayed to improve
system-wide performance.

Severity Filter by the severity level (Critical, High, Medium or Low) associated
with a security event.

Source

Source IP

Filter by the source IP address.

Source Device Filter by source device type, e.g. mobile.

Source Interface Filer by the interface type used by the source user, e.g. wan1.

Source Port Filter by the source interface.

Note: This filter is only available in the All Sessions console,(viewing the
now time display).
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Filter option Description

Source SSID Filter by the Service Set Identifier (SSID) associated with the selected user.
An SSID is a case sensitive, 32 character alphanumerical identifier that
acts as a password attributed to a mobile device.

Status Filter by the maliciousness of a file. The types of possible status' are
Malicious, High, Medium, Low, Clean, Unknown, and Pending.

Note: This filter is only available in the FortiSandbox console.

Threat Filter by threat name and/or URL

Threat Type Filter by threat category, e.g. Illegal/Unethical or P2P.

Type Note: This filter is only available in the Failed Authentications console.

User Name Filter by user name.

VPN Type Filter by Virtual Private Network (VPN) protocol type, eg. PPTP.

Note: This filter is only available in the VPN console.
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Drill-Down Options
Double-click, or right-click, on any entry in a FortiView console and select Drill Down to Details, to view the
following columns (options vary depending on the console selected):

Drill down options are available for all FortiView consoles except All Sessions,
Logical Topology, and Physical Topology.

Option Description

Applications Select to drill down by application to view application-related information, including the
application name, sessions blocked and allowed, bytes sent and received, and the risk level.
You can sort entries by selecting the column header.

Sources Select to drill down by rows to view source-related information, including IP address, device
type, interface type, threat score, number of sessions blocked/allowed, and bytes
sent/received. You can sort entries by selecting the column header.

Destinations Select to drill down by destination to view destination-related information, including the IP
address and geographic region, interface, threat score, number of sessions blocked and
allowed, and bytes sent and received. You can sort entries by selecting the column header.

Countries Select to drill down by country, including the number of sessions, bytes sent and received,
and the bandwidth used.You can sort entries by selecting the column header.

Policies Select to drill down by the policies in use, including source interface, destination interface,
bytes sent and received, and bandwidth used. You can sort entries by selecting the column
header.

Source
Interfaces

Select to drill down by source interface, including bytes sent and received, and bandwidth
used. You can sort entries by selecting the column header.

Destination
Interfaces

Select to drill down by destination interface, including bytes sent and received, and
bandwidth used. You can sort entries by selecting the column header.

Threats Select to drill down by threat to view threat-related information, including the threat name,
category, threat level, threat score, and number of sessions blocked and allowed. You can
sort entries by selecting the column header.

Domains Select to drill down by domain to view domain-related information, including domain name,
category, browsing time, threat weight, number of sessions blocked/allowed, and bytes
sent/received. You can sort entries by selecting the column header.

Categories Select to drill down by category to view category-related information, including category
name, browsing time, threat score, number of sessions blocked/allowed, and bytes
sent/received. You can sort entries by selecting the column header.
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Option Description

Sessions Select to drill down by sessions to view session-related information, including date/time,
source, destination IP address and geographic region, application name,security action,
security event, and bytes sent/received. You can sort entries by selecting the column
header.
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Columns displayed
The following columns appear in the initial window of the dashboards. Some columns may only be visible by
selecting them from the column drop-down menu. Options vary depending on the dashboard selected.

Column name Description

Action Displays the type of response taken to a security event. The types of
possible actions are as follows:

l Allowed: No threat was detected and the connection was let through.
l Blocked: A threat was detected and the connection was not let through.
l Reset: A possible issue was detected and the connection was reset.
l Traffic Shape: Some data packets may have been delayed to improve
system-wide performance.

Note: This column is only available in the All Sessions console.

Application Displays the application name and service. When Time Display is set to
now, you can access further information about an application by selecting
the column entry.

Application Category Displays the type of application used in the selected session, e.g. video
player, social media.

Note: This column is only available in the All Sessions console.

Application ID Displays the identification number associated with the application used in
the selected session.

Note:This column is only available in the All Sessions console.

Application Risk

Risk

Displays the application risk level. You can hover the mouse cursor over the
entry in the column for additional information, and select the column
header to sort entries by level of risk.

Risk uses a 5-point risk rating. The rating system is as follows:

l Critical: Applications that are used to conceal activity to evade
detection.

l High: Applications that can cause data leakage, are prone to
vulnerabilities, or may download malware.

l Medium: Applications that can be misused.
l Elevated: Applications that are used for personal communications or

can lower productivity.
l Low: Business-related applications or other harmless applications.
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Column name Description

Bandwidth Displays information for bandwidth calculated on a per-session level,
providing administrators the ability to sort realtime bandwidth usage in
descending order.

Browsing Time Displays the amount of time a user has spent browsing a web site (in
seconds).

Note: This column is only available in theWeb Sites console, in
Categories view..

Bytes
(Sent/Received)

Displays the size of sent and received data packets, as measured in bytes.
Select the column header to sort the entries by size.

Note: This information is available on some consoles as two separate
columns: Sent and Received.

Category Displays the category descriptor appropriate to whatever console is being
displayed. For example, threat categories are displayed in the Threats
console.

Cloud User Displays the users accessing cloud applications by IP address.

Note: This column is only available in the Cloud Applications console, in
Users view.

Configuration Changes Displays the number of configuration changes made by the user. You can
hover the mouse cursor over an entry for additional information.

Note: This column is only available in the Admin Logins console.

Connections Displays the number of VPN connections made by the selected user..

Note: This column is only available in the VPN console.

Country Displays the country from which the selected traffic is originating.

Note: This column is only available in the Countries console.

Destination Displays the destination name, IP address and geographic region.

Destination Country Displays the country session data is being sent to.

Note: This column is only available in the All Sessions console.

Destination Interface Displays which interface session data is being sent through, e.g. wan1.
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Column name Description

Destination Port Displays the port number of the destination server being used to accept
data.

Note: This column is only available in the All Sessions console.

Device Displays the device IP address or Fully Qualified Domain Name (FQDN).

Domain Displays the domain associated with the selected web site, e.g.
google.com.

Note: This column is only available in theWeb Sites console.

DST Nat IP

NAT Destination

Displays the Network Address Translation (NAT) IP address associated
with the destination server.

Note: This column is only available in the All Sessions console.

DST Nat Port

NAT Destination Port

Displays the Network Address Translation (NAT) port number associated
with the destination server.

Note: This column is only available in the All Sessions console.

Duration Displays the amount of time (in seconds) a user has been logged in.

Note: This column is only available in the Admin Logins console.

Event Name (Description) Displays the name and description of the selected security event.

Note: This column is only available in the System Events console.

Events Displays the number of security events that occurred within a selected
session.

Note: This column is only available in the System Events console.

Expires Displays the amount of time a session has (in seconds) before it is set to
expire.

Note: This column is only available in the All Sessions console, in now
Time Display view.

Failed Logins Displays the number of failed login attempts made by an administrator
over the specified time period.

Note: This column is only available in the Admin Logins console.
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Column name Description

Files (Up/Down) Displays the number of files uploaded and downloaded. Hover the mouse
cursor over the entry in the column for additional information.

Note: This column is only available in the Cloud Applications console.

FortiASIC Displays the type of FortiASIC hardware acceleration used in the specified
session, if present.

Note: This column is only available in the All Sessions console, in the
now Time Display view.

Group Displays the group ID associated with the selected session.

Note: This column is only available in the All Sessions console.

Last Connection Time Displays the most recent instance of connection to the selected Virtual
Private Network (VPN).

Note: This column is only available in the VPN console.

Level

Threat Level

Displays the threat level. Select the column header to sort entries by threat
level.

Log ID Displays the identification number for the data log associated with this
entry.

Note: This column is only available in the All Sessions console.

Login IDs Displays the number of login IDs associated with the selected cloud
application.

Note: This column is only available in the Cloud Applications console, in
Applications view.

Login Type Displays the type of login (eg. WEP) associated with the displayed
authentication attempt.

Note: This column is only available in the Failed Authentications
console.

Logins Displays the number of successful logins made by an administrator over
the specified time period.

Note: This column is only available in the Admin Logins console.
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Column name Description

Pending Note: This column is only available in the FortiSandbox column, in
Source view.

Policy ID Displays the identification number of the policy under which the selected
connection was allowed.

Security Action Displays the action taken in response to the selected security event. The
types of possible actions are as follows: 

l Allowed: No threat was detected and the connection was let through.
l Blocked: A threat was detected and the connection was not let

through.
l Reset: A possible issue was detected and the connection was reset.
l Traffic Shape: Some data packets may have been delayed to improve

system-wide performance.

Sessions Displays the number of sessions associated with the selected destination.

Note: This column only appears in the Destinations console, in the now
Time Display view.

Sessions
(Blocked/Allowed)

Displays the number of sessions blocked and allowed by FortiOs.

In some consoles, entries can be sorted by number of sessions by selecting
the column header..

Severity Displays the severity level (Critical, High, Medium or Low) associated
with the selected security event.

Source Displays the source IP address and/or user ID, if applicable.

Source Interface Displays which interface is being used by the destination server (eg. wan1).

Source Port Displays the port number being used by the source server to send data.

Source SSID Displays the Service Set Identifier (SSID) associated with the selected
user.

Note: This column is only available in theWifi Clients console.

Src NAT IP

NAT Source

Displays the Network Address Translation (NAT) IP address associated
with the source server.
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Column name Description

Src NAT Port

NAT Source Port

Displays the Network Address Translation (NAT) port number associated
with the source server.

Status The types of possible status' areMalicious, High, Medium, Low, Clean,
Unknown, and Pending.

Note: This console is only available in the FortiSandbox console, in Files
view.

Submitted Displays the number of files submitted to the FortiSandbox for assessment
in the selected session.

Note: This column is only available in the FortiSandbox console, in Files
view.

Threat Displays the threat type detected in the selected session.

Threat Score
(Blocked/Allowed)

Displays the threat score value, a measurement of the total number of
threats detected over the course of the session. You can select the column
header to sort entries by threat score.

Threat Weight Displays the threat weight profile associated with the selected session.

Timestamp Displays the selected session's PHP timestamp.

User

User Name Displays the user name associated with the selected administrator.

Videos Played Displays the number of videos played via cloud applications.

Note: This column is only available in the Cloud Applications console.
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Risk level indicators
There are currently two consoles within FortiView that display the Risk associated with the console:
Applications and Cloud Applications. Each application pose different levels of risk to the network,
represented by a colour code.

The following table identifies each risk level, from least to most severe:

Indicator Risk Description

Green:
Risk Level 1

These applications have little to no risk level, with no assigned risk
definition. Application file-sharing may result in data leakage, which would
be a typical example of a low level risk.

An example application would be the Google toolbar, or Dropbox.

Blue:
Risk Level 2

These applications have an elevated risk level and typically use excessive
bandwidth. High bandwidth consumption can lead to increased operational
costs.

An example application would be Bittorrent.

Yellow:
Risk Level 3

These applications have a low risk level and are typically evasive.

Evasive applications can lead to compliance risks, and could include
applications such as JustinTV and GlypeProxy.

Orange:
Risk Level 4

These applications have a high risk level, and are defined as using both
excessive and evasive bandwidth.

Example applications would be AutoHideIP and PandoraTV.

Red:
Risk Level 5

Applications that have a high risk level are prone to malware or
vulnerabilities that can introduce business continuity risks.
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Troubleshooting FortiView

Troubleshooting FortiView

No logging data is displayed
In order for information to appear in the FortiView consoles, disk logging must be selected for the FortiGate unit.
To select disk logging, go to Log & Report > Log Settings.

Disk logging is disabled by default for some FortiGate units. To enable disk logging, enter the following command
in the CLI:

config log disk setting
set status enable

end

Only certain FortiGate models support Disk Logging — refer to the FortiView Feature Support - Platform Matrix
on page 1258 for more information.

Logging is enabled, but data is not appearing
Some FortiView consoles require certain features to be enabled and working before they will display any data. For
example, the Web Filtering FortiView page requires that a Web Filtering profile be configured in Security
Profiles > Web Filter and then applied to a policy in Policy & Objects > IPv4 Policy.

First, ensure the feature is enabled in System > Feature Visibility, and then go to the appropriate page to
make sure that the feature is being implemented. If it is working but is producing no data, FortiView will have
nothing to display.
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Chapter 11 - Fortinet Communication Ports and Protocols

Ports and protocols

This document contains a series of tables showing the communication ports and protocols used between:

l FortiGate
l FortiAnalyzer
l FortiAP-S
l FortiAuthenticator
l FortiClient
l FortiCloud
l FortiDB
l FortiGuard
l FortiMail
l FortiManager
l FortiPortal
l FortiSandbox
l and 3rd-party servers using FSSO.

Additionally, Fortinet's proprietary protocols are documented, showing what Fortinet products they operate with,
how they behave, and how they carry out their roles:

l FGCP - FortiGate Clustering Protocol
l FGSP - FortiGate Session Life Support Protocol
l FGFM - FortiGate to FortiManager Protocol
l SLBC - Session-aware Load Balancing Cluster
l Fortinet Security Fabric
l FortiTelemetry/On-Net/FortiClient Endpoint Compliance
l FortiGuard
l FortiLink
l FortiOSWAN optimization
l FSSO - Fortinet Single Sign-On
l OFTP - Optimized Fabric Transfer Protocol
l FortiClient EMS - Enterprise Management Server

Some protocols contain CLI syntax that control their ports and functionality.
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What's new in FortiOS 5.6

This chapter describes new authentication features added to FortiOS 5.6.

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

l FortiGuard communication default port change
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FortiGate open ports

Incoming ports

Purpose Protocol/Port

FortiAP-S Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/443

CAPWAP UDP/5246, UDP/5247

FortiAuthenticator RADIUS UDP/1812

FSSO TCP/8000

FortiGate HAHeartbeat ETH Layer 0x8890, 0x8891, and 0x8893

HA Synchronization TCP/703, UDP/703

FortiGuard Management TCP/541

AV/IPS UDP/9443
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FortiGate open ports

Incoming ports

Purpose Protocol/Port

FortiManager AV/IPS Push UDP/9443

SSH CLI Management TCP/22

Management TCP/541

SNMP Poll UDP/161, UDP/162

FortiGuard Queries TCP/443

FortiPortal API communications (FortiOS REST API,
used for Wireless Analytics)

TCP/443

Others Web Admin TCP/80, TCP/443

FSSO TCP/8000

Policy Override Authentication TCP/443, TCP/8008, TCP/8010

FortiClient Portal TCP/8009

Policy Override Keepalive TCP/1000, TCP/1003

SSL VPN TCP/10443

3rd-Party Servers FSSO TCP/8000

Outgoing ports

Purpose Protocol/Port

FortiAnalyzer Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

FortiAuthenticator LDAP, PKI Authentication TCP or UDP/389

FortiCloud Registration, Quarantine, Log & Report,
Syslog

TCP/443

OFTP TCP/514

Management TCP/541

Contract Validation TCP/443
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FortiGate open ports

Outgoing ports

Purpose Protocol/Port

FortiGate HAHeartbeat ETH Layer 0x8890, 0x8891, and 0x8893

HA Synchronization TCP/703, UDP/703

FortiGuard AV/IPS Update TCP/443, TCP/8890

Cloud App DB TCP/9582

FortiGuard Queries UDP/53, UDP/8888

DNS UDP/53, UDP/8888

Registration TCP/80

Alert Email, Virus Sample TCP/25

Management, Firmware, SMS, FTM,
Licensing, Policy Override

TCP/443

Central Management, Analysis TCP/541

FortiManager Management TCP/541

IPv6 FGFM connection TCP/542

Log & Report TCP or UDP/514

Secure SNMP UDP/161, UDP/162

FortiGuard Queries TCP/8890, UDP/53

FortiSandbox OFTP TCP/514

Note that, while a proxy is configured, FortiGate uses the following URLs to access
the FortiGuard Distribution Network (FDN):

l update.fortiguard.net
l service.fortiguard.net
l support.fortinet.com
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FortiAnalyzer open ports

Incoming ports

Purpose Protocol/Port

FortiAP-S Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

Event Logs UDP/5246

FortiClient Syslog UDP/514

FortiGate Syslog, OFTP, Registration, Quarantine,
Log & Reports

TCP/514

FortiMail Syslog UDP/514

FortiManager Syslog & OFTP TCP/514, UDP/514

Registration TCP/541

FortiPortal API communications (JSON and
XML APIs respectively)

TCP/443, TCP/8080
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FortiAnalyzer open ports

Incoming ports

Purpose Protocol/Port

Others SSH CLI Management TCP/22

Web Admin TCP/80, TCP/443

REST TCP/443

DC Polling TCP/445

Logg Agg TCP/3000

Outgoing ports

Purpose Protocol/Port

FortiGuard AV/IPS, SMS, FTM, Licensing, Policy
Override, RVS, URL/AS Update

TCP/443

FortiPortal
(FortiPortal only
receives log
communications
from FortiAnalyzer
when it is acting as
a collector)

Log communications TCP/514, UDP/514

3rd-Party Servers LDAP & PKI Authentication TCP/389, UDP/389

Log & Report TCP/21, TCP/22

Configuration Backups TCP/22

Alert Email TCP/25

DNS UDP/53

NTP UDP/123

SNMP Traps UDP/162

Report Query TCP/389

Syslog &OFTP TCP or UDP/514

RADIUS UDP/1812
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FortiAP-S open ports

Outgoing ports

Purpose Protocol/Port

FortiAnalyzer Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

Event Logs UDP/5246*

FortiCloud Initial Discovery TCP/443

Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

Event Logs UDP/5246*

FortiGate Syslog, Registration, Quarantine, Log
& Report

TCP/443

CAPWAP UDP/5246*, UDP/5247*
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FortiAP-S open ports

Outgoing ports

Purpose Protocol/Port

FortiGuard FortiGuard Queries UDP/53, UDP/8888

Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

Event Logs UDP/5246*

* - Only FortiAPmodels, not FortiAP-S.
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FortiAuthenticator open ports

Incoming ports

Purpose Protocol/Port

FortiAuthenticator (HA) HA heartbeat UDP/720

LB slave sync UDP/721, UDP/1194

FortiClient SSO Mobility Agent, FSSO TCP/8001

FortiGate LDAP, PKI Authentication TCP or UDP/389

RADIUS UDP/1812

FSSO TCP/8000
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FortiAuthenticator open ports

Incoming ports

Purpose Protocol/Port

Others SSH CLI TCP/22

Telnet TCP/23

HTTP & SCEP TCP/80

SNMP Poll UDP/161

Web Admin TCP/80, TCP/443

LDAP TCP/389

LDAPS TCP/636

RADIUS UDP/1812, UDP/1813

OCSP TCP/2560

3rd-Party Servers FSSO & Tiers TCP/8002, TCP/8003

Outgoing ports

Purpose Protocol/Port

FortiAuthenticator (HA) HA heartbeat UDP/720

(LB slave) LB slave sync UDP/721, UDP/1194

FortiGate RADIUS UDP/1812

FSSO TCP/8000

FortiGuard AV/IPS Updates TCP/443

Virus Sample TCP/25

SMS, FTM, Licensing, Policy Override
Authentication, URL/AS Updates

TCP/443

Registration TCP/80
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FortiAuthenticator open ports

Outgoing ports

Purpose Protocol/Port

3rd-Party Servers SMTP, Alerts, Virus Sample TCP/25

DNS UDP/52

Windows AD TCP/88

NTP UDP/123

LDAP TCP or UDP389

Domain Control TCP/445

LDAPS TCP/636

FSSO & Tiers TCP/8002, TCP/8003
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FortiClient open ports

Outgoing ports

Purpose Protocol/Port

FortiAnalyzer Syslog UDP/514

FortiAuthenticator SSO Mobility Agent, FSSO TCP/8001

FortiGate VPN Settings TCP/8900

Policy Override Authentication TCP/8010

Explicit Proxy TCP/8080

FortiGuard AV Update & Registration TCP/80

URL/AS Rating, DNS, FDN, FortiGuard
Queries

UDP/53, UDP/8888
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FortiCloud open ports

Incoming ports

Purpose Protocol/Port

FortiAP-S Initial Discovery TCP/443

Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

Event Logs UDP/5246

FortiGate Registration, Quarantine, Log & Report,
Syslog

TCP/443

OFTP TCP/514

Management TCP/541

Contract Validation TCP/443

Outgoing ports

Purpose Protocol/Port

FortiGuard Registration TCP/443
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FortiDB open ports

Incoming ports

Purpose Protocol/Port

Others SSH CLI Management TCP/22

Telnet CLI Management TCP/23

Web Admin TCP/80, TCP/443

SNMP Traps UDP/161

Agent Communication TCP/9116, TCP/9117

Outgoing ports

Purpose Protocol/Port

FortiGuard
(FortiDB will use a
random port picked
by the kernel)

FortiGuard Updates TCP/80

FortiMonitor SSH, SFTP TCP/22

3rd-Party Servers Email Notifications/Reports TCP/25

SNMP Traps UDP/162

Syslog UDP/514
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FortiGuard open ports

Incoming ports

Purpose Protocol/Port

FortiAnalyzer AV/IPS Updates, SMS, FTM, Licensing,
Policy Overrides, RVS, URL/AS Update

TCP/443

FortiAP-S FortiGuard Queries UDP/53, UDP/8888

Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

Event Logs UDP/5246
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FortiGuard open ports

Incoming ports

Purpose Protocol/Port

FortiAuthenticator AV/IPS Updates TCP/443

Virus Sample TCP/25

SMS, FTM, Licensing, Policy Override
Authentication, URL/AS Updates

TCP/443

Registration TCP/80

FortiClient AV Update & Registration TCP/80

URL/AS Rating, DNS, FDN, FortiGuard
Queries UDP/53, UDP/8888

FortiCloud Registration TCP/443

FortiGate AV/IPS Update, Management, Firmware,
SMS, FTM, Licensing, Policy Override TCP/443, TCP/8890

Cloud App DB TCP/9582 (flow.fortinet.net)

FortiGuard Queries, DNS UDP/53, UDP/8888

Registration TCP/80

Alert Emails, Virus Sample TCP/25

Central Management, Analysis TCP/541

FortiMail AS Rating UDP/53

AV/AS Update TCP/443

FortiManager AV/IPS Updates, URL/AS Update,
Firmware, SMS, FTM, Licensing, Policy
Override Authentication, Registration

TCP/443

FortiClient updates TCP/80

FortiSandbox
(FortiSandbox will
use a random port
picked by the
kernel)

FortiGuard Distribution Servers TCP/8890

FortiGuard Web Filtering Servers UDP/53, UDP/8888
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FortiGuard open ports

Outgoing ports

Purpose Protocol/Port

FortiGate Management TCP/541

AV/IPS UDP/9443

FortiMail AV Push UDP/9443

FortiManager AV/IPS UDP/9443
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FortiMail open ports

When operating in its default configuration, FortiMail does not accept TCP or UDP
connections on any port except port1 and port2 network interfaces, which accept:

l ICMP pings,
l HTTPS connections on TCP/443,
l and SSH connections on TCP/22.
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FortiMail open ports

Incoming ports

Purpose Protocol/Port

Admin by
Console or PC

SSH, Telnet, HTTP, SSH, Console TCP/443 or TCP/80 or TCP/22 or TCP/23

Email Client Quarantine View/Retrieve TCP/80 or TCP/443 or TCP/110

SMTP or SMTPS TCP/25 or TCP/465

POP3 or POP3S TCP/110 or TCP/995 (server mode only)

IMAP or IMAPS TCP/143 or TCP/993 (server mode only)

WebDAV and CalDAV TCP/8008

FortiMail Base port for HA heartbeat signal UDP/20000

Synchronization control UDP/20001

File synchronization TCP/20002

Data synchronization TCP/20003

Checksum synchronization TCP/20004

HA service monitoring (remote SMTP) TCP/25

HA service monitoring (remote HTTP) TCP/80

HA service monitoring (remote POP3) TCP/110

HA service monitoring (remote IMAP) TCP/143

Clear Text Central Quarantine TCP/514

SSL Central Quarantine TCP/6514

FortiManager SNMP Poll TCP/161

AV Push

FortiGuard AV Push UDP/9443
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FortiMail open ports

Incoming ports

Purpose Protocol/Port

External Email
Server

SMTP or SMTPS TCP/25 or 465

Storage: iSCI, NFS TCP/3260 (iSCI), TCP/2049 (NFS)

Config Backup SFTP / FTP

Mail Data Backup NFS, SMB/CIFS, SSH, external USB
(direct connected), iSCSI

Protected Email
Server

SMTP or SMTPS TCP/25 or 465

Outgoing ports

Purpose Protocol/Port

FortiAnalyzer OFTP UDP/514

FortiManager SNMP Traps UDP/162

AV/AS Query

FortiGuard AS Rating UDP/53 or 8888, 8889

AV/AS Update TCP/443
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FortiMail open ports

Outgoing ports

Purpose Protocol/Port

FortiMail Base port for HA heartbeat signal UDP/20000

Synchronization control UDP/20001

File synchronization TCP/20002

Data synchronization TCP/20003

Checksum synchronization TCP/20004

HA service monitoring (remote SMTP) TCP/25

HA service monitoring (remote HTTP) TCP/80

HA service monitoring (remote POP3) TCP/110

HA service monitoring (remote IMAP) TCP/143

Clear Text Central Quarantine TCP/514

SSL Central Quarantine TCP/6514

External
Email Server

SMTP or SMTPS TCP/25 or TCP/465

Protected Email
Server

SMTP or SMTPS TCP/25 or TCP/465

POP3 Auth TCP/110

IMAP Auth TCP/143

Others Dyn DNS TCP/80 *

DNS, RBL UDP/53

NTP UDP/123

Alert Email TCP/25

LDAP or LDAPS TCP/389 or TCP/636

RADIUS Auth TCP/1812

NAS TCP/21, TCP/22, TCP/2049

OCSP (for PKI user) TCP/80, or defined by certificate
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FortiMail open ports

Outgoing ports

Purpose Protocol/Port

FortiSandbox /
FortiSandbox
Cloud

Communication TCP/443, TCP/514

* - FortiMail generates outbound traffic and sends an HTTP SYN request via TCP/80. The Fortinet RSS Feed
widget provides a convenient display of the latest security advisories and discovered threats from Fortinet. Also, if
an email message contains a shortened URI that redirects to another URI, it would cause FortiMail to send an
HTTP SYN request to the shortened URI to get the redirected URI.

Note that FortiMail uses the following URLs to access the FortiGuard Distribution
Network (FDN):

l update.fortiguard.net
l service.fortiguard.net
l support.fortinet.com

Furthermore, FortiMail performs these queries and updates listed below using the
following ports and protocols:

l FortiGuard Antispam rating queries: UDP/53, 8888, 8889
l FortiGuard AntiVirus Push updates: UDP/9443
l FortiGuard Antispam or AntiVirus updates: TCP/443
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FortiManager open ports

Incoming ports

Purpose Protocol/Port

FortiGate Management TCP/541

IPv6 FGFM connection TCP/542

Log & Report TCP or UDP/514

FortiGuard Queries TCP/8890, UDP/53

FortiGuard AV/IPS UDP/9443

FortiMail Registration UDP/9443

AV/ASQuery

FortiManager FortiClient Manager TCP/6028

FortiPortal API communications (JSON and
XML APIs respectively)

TCP/443, TCP/8080
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FortiManager open ports

Incoming ports

Purpose Protocol/Port

Others SSH CLI Management TCP/22

Telnet CLI Management TCP/23

Web Admin TCP/80, TCP/443

Outgoing ports

Purpose Protocol/Port

FortiAnalyzer Syslog & OFTP TCP/514, UDP/514

Registration TCP/541

FortiGate AV/IPS Push UDP/9443

SSH CLI Management TCP/22

Management TCP/541

FortiGuard AV/IPS Updates, URL/AS Update,
Firmware, SMS, FTM, Licensing, Policy
Override Authentication, Registration

TCP/443

FortiClient updates TCP/80

FortiMail AV Push

FortiManager FortiClient Manager TCP/6028

3rd-Party Servers DNS UDP/53

NTP UDP/123

Proxied HTTPS Traffic TCP/443

RADIUS UDP/1812

Note that, while a proxy is configured, FortiManager uses the following URLs to
access the FortiGuard Distribution Network (FDN) for the following updates:

l fds1.fortinet.com - FortiGate AV/IPS package downloads
l guard.fortinet.net - Webfilter/AntiSpam DB and AVfileQuery DB downloads
l forticlient.fortinet.com - FortiClient signature package downloads
l fgd1.fortigate.com:8888 - FortiClient Webfilter queries to FortiGuard
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FortiPortal open ports

Incoming ports

Purpose Protocol/Port

End User/MSSP
Admin

FortiPortal utilization by end users and
MSSP admins

TCP/443

FortiAnalyzer Log communications TCP/514, UDP/514

Outgoing ports

Purpose Protocol/Port

FortiGate API communications (FortiOS REST API,
used for Wireless Analytics)

TCP/443

FortiManager API communications (JSON and
XML APIs respectively)

TCP/443, TCP/8080

FortiAnalyzer API communications (JSON and
XML APIs respectively)

TCP/443, TCP/8080

PortalDB MySQL communications TCP/3306

CollectorDB MySQL communications TCP/3306
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FortiSandbox open ports

Incoming ports

Purpose Protocol/Port

FortiGate OFTP TCP/514

Others SSH CLI Management TCP/22

Telnet CLI Management TCP/23

Web Admin TCP/80, TCP/443

OFTP Communication with FortiGate
& FortiMail

TCP/514

Third-party proxy server for ICAP servers ICAP: TCP/1344

ICAPS: TCP/11344

Outgoing ports

Purpose Protocol/Port

FortiGuard
(FortiSandbox will
use a random port
picked by the
kernel)

FortiGuard Distribution Servers TCP/8890

FortiGuard Web Filtering Servers UDP/53, UDP/8888
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FortiSandbox open ports

Outgoing ports

Purpose Protocol/Port

FortiSandbox
Community
Cloud
(FortiSandbox will
use a random port
picked by the
kernel)

Upload detected malware information TCP/443, UDP/53

Note that FortiSandbox uses the following FQDNs to access the FortiSandbox
Community Cloud, depending on which protocol and port is used:

l TCP/443: fqdl.fortinet.net
l UDP/53: fqsvr.fortinet.net

Services and port numbers required for FortiSandbox
The tables above show all the services required for FortiSandbox to function correctly. You can use the diagnostic
FortiSandbox command test-network to verify that all the services are allowed by the upstream. If the result
is Passed, then there is no issue. If there is an issue with a specific service, it will be shown in the command
output, and inform you which port needs to be opened.

This command checks:

l VM Internet access
l Internet connection
l System DNS resolve speed
l VM DNS resolve speed
l Ping speed
l Wget speed
l Web Filtering service
l FortiSandbox Community Cloud service
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3rd-party servers open ports

Incoming ports

Purpose Protocol/Port

FortiAnalyzer LDAP & PKI Authentication TCP/389, UDP/389

Log & Report TCP/21, TCP/22

Configuration Backups TCP/22

Alert Emails TCP/25

DNS UDP/53

NTP UDP/123

SNMP Traps UDP/162

Report Query TCP/389

Syslog & OFTP TCP or UDP/514

RADIUS UDP/1812
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3rd-party servers open ports

Incoming ports

Purpose Protocol/Port

FortiAuthenticator SMTP, Alerts, Virus Sample TCP/25

DNS UDP/52

Windows AD TCP/88

NTP UDP/123

LDAP TCP or UDP/389

Domain Control TCP/445

LDAPS TCP/636

FSSO & Tiers TCP/8002, TCP/8003

FortiManager DNS UDP/53

NTP UDP/123

SNMP Traps UDP/162

Proxied HTTPS Traffic TCP/443

RADIUS UDP/1812

Outgoing ports

Purpose Protocol/Port

FortiAuthenticator FSSO & Tiers TCP/8002, TCP/8003

FortiGate FSSO TCP/8000
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Fortinet proprietary protocols

The following section provides a full list of Fortinet's proprietary protocols, their purposes, and what ports they
operate on:

l FGCP - FortiGate Clustering Protocol
l FGSP - FortiGate Session Life Support Protocol
l FGFM - FortiGate to FortiManager Protocol
l SLBC - Session-aware Load Balancing Cluster
l Fortinet Security Fabric
l FortiTelemetry/On-Net/FortiClient Endpoint Compliance
l FortiGuard
l FortiLink
l FortiOSWAN optimization
l FSSO - Fortinet Single Sign-On
l OFTP - Optimized Fabric Transfer Protocol
l FortiClient EMS - Enterprise Management Server
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FGCP - FortiGate Clustering Protocol

In an active-passive HA configuration, the FortiGate Clustering Protocol (FGCP) provides failover protection,
whereby the cluster can provide FortiGate services even when one of the cluster units loses connection. FGCP is
also a Layer 2 heartbeat that specifies how FortiGate units communicate in an HA cluster and keeps the cluster
operating.

You cannot mix FGCP and SLBC clusters in the same chassis.

The FortiGate's HA Heartbeat listens on ports TCP/703, TCP/23, or ETH layer 2/8890.

Virtual MAC addresses

FGCP assigns virtual MAC addresses to each primary unit interface in an HA cluster. Virtual MAC addresses are
in place so that, if a failover occurs, the new primary unit interfaces will have the same MAC addresses as the
failed primary unit interfaces. If the MAC addresses were to change after a failover, the network would take
longer to recover because all attached network devices would have to learn the new MAC addresses before they
could communicate with the cluster.

If a cluster is operating in Transparent mode, FGCP assigns a virtual MAC address for the primary unit
management IP address. Since you can connect to the management IP address from any interface, all of the
FortiGate interfaces appear to have the same virtual MAC address.
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FGCP - FortiGate Clustering Protocol

When a cluster starts up, after a failover, the primary unit sends gratuitous ARP packets to update the switches
connected to the cluster interfaces with the virtual MAC address. The switches update their MAC forwarding
tables with this MAC address. As a result, the switches direct all network traffic to the primary unit. Depending on
the cluster configuration, the primary unit either processes this network traffic itself or load balances the network
traffic among all of the cluster units.

You cannot disable sending gratuitous ARP packets, but you can change the number of packets that are sent (1-
60 ARP packets) by entering the following command:

config system ha
set arps <integer>

end

You can change the time between ARP packets (1-20 seconds) by entering the following command:

config system ha
set arps-interval <integer>

end

Assigning virtual MAC addresses

Virtual MAC addresses are determined based on the following formula:

00-09-0f-09-<group-id_hex>-<vcluster_integer><idx>

where:

l <group-id_hex>: The HA group ID for the cluster converted to hexadecimal. The table below lists some example
virtual MAC addresses set for each group ID:

Integer group ID Hexadecimal group ID

0 00

1 01

2 02

3 03

... ...

10 0a

11 0b

... ...

63 3f

... ...

255 ff
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FGCP - FortiGate Clustering Protocol

l <vcluster_integer>: This value is 0 for virtual cluster 1 and 2 for virtual cluster 2. If virtual domains are not
enabled, HA sets the virtual cluster to 1 and by default all interfaces are in the root virtual domain. Including virtual
cluster and virtual domain factors in the virtual MAC address formula means that the same formula can be used
whether or not virtual domains and virtual clustering is enabled.

l <idx>: The index number of the interface. In NAT mode, interfaces are numbered from 0 to x (where x is the
number of interfaces). The interfaces are listed in alphabetical order on the web-based manager and CLI. The
interface at the top of the interface list is first in alphabetical order by name and has an index of 0. The second
interface in the list has an index of 1 and so on. In Transparent mode, the index number foe the management IP
address is 0.

Every FortiGate unit physical interface has two MAC addresses: the current hardware address and the permanent
hardware address. The permanent hardware address cannot be changed, as it is the actual MAC address of the
interface hardware. The current hardware address can be changed, but only when a FortiGate unit is not
operating in HA. For an operating cluster, the current hardware address of each cluster unit interface is changed
to the HA virtual MAC address by the FGCP.

You cannot change an interface MAC address and you cannot view MAC addresses from the system interface
CLI command.

You can use the get hardware nic <interface_name_str> (or diagnose hardware
deviceinfo nic <interface_str>) command to display both MAC addresses for any FortiGate
interface. This command displays hardware information for the specified interface, including the current hardware
address (as Current_HWaddr) and the permanent hardware address (as Permanent_HWaddr). For some
interfaces, the current hardware address is displayed as MAC.

Failover protection

FGCP supports three kinds of failover protection:

1. Device failover: Automatically replaces a failed device and restarts traffic flow with minimal impact on the
network. All subordinate units in an active-passive HA cluster are constantly waiting to negotiate to become
primary units. Only the heartbeat packets sent by the primary unit keep the subordinate units from becoming
primary units. Each received heartbeat packet resets negotiation timers in the subordinate units. If this timer is
allowed to run out because the subordinate units do not receive heartbeat packets from the primary unit, the
subordinate units assume that the primary unit has failed, and negotiate to become primary units themselves. The
default time interval between HA heartbeats is 200 ms.

2. Link failover:Maintains traffic flow if a link fails. In this case, the primary unit does not stop operating, and
therefore participates in the negotiation of selecting a new primary unit. The old primary unit then joins the cluster
as a subordinate unit. Furthermore, any subordinate units with a link failure are unlikely to become the primary
unit in future negotiations.

3. Session failover:With session failover (also called session pickup) enabled, the primary unit informs the
subordinate units of changes to the primary unit connection and state tables, keeping the subordinate units up-to-
date with the traffic currently being processed by the cluster. This helps new primary units resume communication
sessions with minimal loss of data, avoiding the need to restart active sessions.

Synchronization of configurations

The FGCP uses a combination of incremental and periodic synchronization to make sure that the configuration of
all cluster units is synchronized to that of the primary unit. However, there are certain settings that are not
synchronized between cluster units:

l HA override
l HA device priority
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l The virtual cluster priority
l The FortiGate unit host name
l The HA priority setting for a ping server (or dead gateway detection) configuration
l The system interface settings of the HA reserved management interface
l The HA default route for the reserved management interface, set using the ha-mgmt-interface-gateway

option of the config system ha command.

You can disable configuration synchronization by entering the following command:

config system ha
set sync-config disable

end

The command execute ha synchronize can be used to perform a manual synchronization.

The FGCP heartbeat operates on TCP port 703 with an independent IP address not assigned to any FortiGate
interface. You can create an FGCP cluster of up to four FortiGate units. Below is an example of FGCP used to
create an HA cluster installed between an internal network and the Internet.

FGCPHA provides a solution for two key requirements of critical enterprise networking: enhanced reliability and
increased performance, through device, link, and remote link failover protection. Extended FGCP features
include full mesh HA and virtual clustering. You can also fine tune the performance of the FGCP to change how a
cluster forms and shares information among cluster units and how the cluster responds to failures.

Before configuring an FGCP HA cluster, make sure your FortiGate interfaces are configured with static IP
addresses. If any interface gets its address using DHCP or PPPoE you should temporarily switch it to a static
address and enable DHCP or PPPoE after the cluster has been established.
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Heartbeat traffic, such as FGCP, uses multicast on port number 6065 and uses link-
local IPv4 addresses in the 169.254.0.x range. HA heartbeat packets have an
Ethertype field value of 0x8890.

Synchronization traffic, such as FGSP, uses unicast on port number 6066 and the IP
address 239.0.0.2. HA sessions that synchronize the cluster have an Ethertype field
value of 0x8893.

The HA IP addresses are hard-coded and cannot be configured.

How to set up FGCP clustering

This example describes how to enhance the reliability of a network protected by a FortiGate unit by adding a
second FortiGate unit to create a FortiGate Clustering Protocol (FGCP) HA cluster. The FortiGate already on the
network will be configured to become the primary unit by increasing its device priority and enabling override. The
new FortiGate will be prepared by setting it to factory defaults to wipe any configuration changes. Then it will be
licensed, configured for HA, and then connected to the FortiGate already on the network. The new FortiGate
becomes the backup unit and its configuration is overwritten by the primary unit.

If you have not already done so, register the primary FortiGate and apply licenses to it before setting up the
cluster. This includes FortiCloud activation and FortiClient licensing, and entering a license key if you purchased
more than 10 Virtual Domains (VDOMs). You can also install any third-party certificates on the primary FortiGate
before forming the cluster.

The FortiGates should be running the same FortiOS firmware version, and their interfaces should not be
configured to get their addresses from DHCP or PPPoE.

Configuring the primary FortiGate

1. Connect to the primary FortiGate and go to Dashboard > System Information. Change the unit'sHost Name
to identify it as the primary FortiGate.
You can also enter this CLI command:

config system global
set hostname Primary_FortiGate

end

2. You then need to set the HAmode to active-passive. Enter the following CLI command to set the HAmode to
active-passive, set a group name and password, increase the device priority to a higher value (for example, 250)
and enable override:
config system ha

set mode a-p
set group-name My-HA-Cluster
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set password
set priority 250
set override enable
set hbdev ha1 50 ha2 50

end

This command also selects ha1 and ha2 to be the heartbeat interfaces, with their priorities set to 50.
Enabling override and increasing the priority ensures that this FortiGate should become the primary unit.

You can configure these settings in the GUI under System > HA, however the
override can only be enabled in the CLI.

Configuring the backup FortiGate

1. Enter the CLI command below to reset the new FortiGate to factory default settings (skip this step if the FortiGate
is fresh from the factory). It is recommended to set it back to factory defaults to reduce the chance of
synchronization problems.:
execute factoryreset

2. Make sure to change the firmware running on the new FortiGate to the same version running on the primary unit,
register, and apply licenses to it before adding it to the cluster.

3. Then go to Dashboard > System Information. Change the unit'sHost Name to identify it as the backup
FortiGate.
You can also enter this CLI command:

config system global
set hostname Backup_FortiGate

end

4. Duplicate the primary unit's HA settings, except make sure to set the backup device's priority to a lower value and
do not enable override.

Connecting the cluster

Connect the HA cluster as shown in the initial diagram above. Making these connections will disrupt network
traffic as you disconnect and re-connect cables.

When connected, the primary and backup FortiGates find each other and negotiate to form an HA cluster. The
primary unit synchronizes its configuration with the backup FortiGate. Forming the cluster happens automatically
with minimal or no disruption to network traffic.

Heartbeat packet EtherTypes

Normal IP packets are 802.3 packets that have an ethernet type (EtherType) field value of 0x0800. EtherType
values other than 0x0800 are understood as level 2 frames rather than IP packets.

By default, HA heartbeat packets use the following EtherTypes:

l HA heartbeat packets for NAT mode clusters use EtherType 0x8890. These packets are used by cluster units to find
other cluster units and to verify the status of other cluster units while the cluster is operating. You can change the
EtherType of these packets using the ha-eth-type option of the config system ha command.

l HA heartbeat packets for Transparent mode clusters use EtherType 0x8891. These packets are used by cluster
units to find other cluster units and to verify the status of other cluster units while the cluster is operating. You can
change the EtherType of these packets using the hc-eth-type option of the config system ha command.

1335 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



FGCP - FortiGate Clustering Protocol

l HA telnet sessions between cluster units over HA heartbeat links use EtherType 0x8893. The telnet sessions allow
an administrator to connect between FortiGates in the cluster using the execute ha manage command. You
can change the EtherType of these packets using the l2ep-eth-type option under config system ha.

Because heartbeat packets are recognized as level 2 frames, the switches and routers on your heartbeat network
that connect to heartbeat interfaces must be configured to allow them. If level 2 frames are dropped by these
network devices, heartbeat traffic will not be allowed between the cluster units.

Some third-party network equipment may use packets with these EtherTypes for other purposes. For example,
Cisco N5K/Nexus switches use EtherType 0x8890 for some functions. When one of these switches receives
EtherType 0x8890 packets from an attached cluster unit, the switch generates CRC errors and the packets are
not forwarded. As a result, FortiGate units connected with these switches cannot form a cluster.

In some cases, if the heartbeat interfaces are connected and configured so regular traffic flows but heartbeat
traffic is not forwarded, you can change the configuration of the switch that connects the HA heartbeat interfaces
to allow level2 frames with Ethertypes 0x8890, 0x8891, and 0x8893 to pass.

Alternatively, you can use the following CLI options to change the EtherTypes of the HA heartbeat packets:

config system ha
set ha-eth-type <ha_ethertype_4-digit_hex
set hc-eth-type <hc_ethertype_4-digit_ex>
set l2ep-eth-type <l2ep_ethertype_4-digit_hex>

end

For example, use the following command to change the EtherType of the HA heartbeat packets from 0x8890 to
0x8895 and to change the EtherType of HA Telnet session packets from 0x8891 to 0x889f:

config system ha
set ha-eth-type 8895
set l2ep-eth-type 889f

end

Enabling or disabling HA heartbeat encryption and authentication

You can enable HA heartbeat encryption and authentication to encrypt and authenticate HA heartbeat packets.
HA heartbeat packets should be encrypted and authenticated if the cluster interfaces that send HA heartbeat
packets are also connected to your networks.

If HA heartbeat packets are not encrypted the cluster password and changes to the cluster configuration could be
exposed and an attacker may be able to sniff HA packets to get cluster information. Enabling HA heartbeat
message authentication prevents an attacker from creating false HA heartbeat messages. False HA heartbeat
messages could affect the stability of the cluster.

HA heartbeat encryption and authentication are disabled by default. Enabling HA encryption and authentication
could reduce cluster performance. Use the following CLI command to enable HA heartbeat encryption and
authentication.

config system ha
set authentication enable
set encryption enable

end

HA authentication and encryption uses AES-128 for encryption and SHA1 for authentication.
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FortiGate Session Life Support Protocol (FGSP) distributes sessions between two FortiGate units and the FGSP
performs session synchronization. If one of the peers fails, session failover occurs and active sessions fail over to
the peer that is still operating. This failover occurs without any loss of data. Also, the external routers or load
balancers will detect the failover and re-distribute all sessions to the peer that is still operating. The two FortiGate
units must be the same model and must be running the same firmware.

Note that you cannot configure FGSPHAwhen FGCPHA is enabled.

You can also use the config system cluster-sync command to configure FGSP between two FortiGate
units.

The FortiGate's HA Heartbeat listens on ports TCP/703, TCP/23, or ETH Layer 2/8890.

In previous versions of FortiOS, FGSPwas called TCP session synchronization or standalone session
synchronization. However, FGSP has been expanded to include both IPv4 and IPv6 TCP, UDP, ICMP,
expectation, NAT sessions, and IPsec tunnels.
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Configuration synchronization

Configuration synchronization can also be performed, allowing you to make configuration changes once for both
FortiGate units instead of requiring multiple configuration changes on each FortiGate unit. However interface IP
addresses, BGP neighbor settings, and other settings that identify the FortiGate unit on the network are not
synchronized. You can enable configuration synchronization by entering the following command:

config system ha
set standalone-config-sync enable

end

UDP and ICMP (connectionless) session synchronization

In many configurations, due to their non-stateful nature, UDP and ICMP sessions don't need to be synchronized
to naturally failover. However, if it is required, you can configure the FGSP to also synchronize UDP and ICMP
sessions by entering the following command:

config system ha
set session-pickup enable
set session-pickup-connectionless enable

end

Expectation (asymmetric) session synchronization

Synchronizing asymmetric traffic can be very useful in situations where multiple Internet connections from
different ISPs are spread across two FortiGates.

The FGSP enforces firewall policies for asymmetric traffic, including cases where the TCP 3-way handshake is
split between two FortiGates. For example, FGT-A receives the TCP-SYN, FGT-B receives the TCP-SYN-ACK,
and FGT-A receives the TCP-ACK. Under normal conditions a firewall will drop this connection since the 3-way
handshake was not seen by the same firewall. However two FortiGates with FGSP configured will be able to
properly pass this traffic since the firewall sessions are synchronized.

If traffic will be highly asymmetric, as described above, the following command must be enabled on both
FortiGates:

config system ha
set session-pickup enable
set session-pickup-expectation enable

end

Security profile inspection with asymmetric and symmetric traffic

Security profile inspection, flow or proxy based, is not expected to work properly if the traffic in the session is load
balanced across more than one FortiGate in either direction. However, flow-based inspection should be used in
FGSP deployments.

For symmetric traffic, security profile inspection can be used but with the following limitations:

l No session synchronization for the sessions inspected using proxy-based inspection. Sessions will drop and need to
be reestablished after data path failover.

l Sessions with flow-based inspection will failover, and inspection of sessions after a failover may not work.
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Improving session synchronization performance

Two HA configuration options are available to reduce the performance impact of enabling session failover (also
known as session pickup): reducing the number of sessions that are synchronized by adding a session pickup
delay, and using more FortiGate interfaces for session synchronization.

Reducing the number of sessions that are synchronized

If session pickup is enabled, as soon as new sessions are added to the primary unit session table they are
synchronized to the other cluster units. Enable the session-pickup-delay CLI option to reduce the number of
sessions that are synchronized by synchronizing sessions only if they remain active for more than 30 seconds.
Enabling this option could greatly reduce the number of sessions that are synchronized if a cluster typically
processes very many short duration sessions, which is typical of most HTTP traffic for example.

Use the following command to enable a 30 second session pickup delay:

config system ha
set session-pickup-delay enable

end

Enabling session pickup delay means that if a failover occurs more sessions may not be resumed after a failover.
In most cases short duration sessions can be restarted with only a minor traffic interruption. However, if you
notice too many sessions not resuming after a failover you might want to disable this setting.

Using multiple FortiGate interfaces for session synchronization

Using the session-sync-dev option, you can select one or more FortiGate interfaces to use for synchronizing
sessions as required for session pickup. Normally session synchronization occurs over the HA heartbeat link.
Using this HA option means only the selected interfaces are used for session synchronization and not the HA
heartbeat link. If you select more than one interface, session synchronization traffic is load balanced among the
selected interfaces.

Moving session synchronization from the HA heartbeat interface reduces the bandwidth required for HA heartbeat
traffic and may improve the efficiency and performance of the cluster, especially if the cluster is synchronizing a
large number of sessions. Load balancing session synchronization among multiple interfaces can further improve
performance and efficiency if the cluster is synchronizing a large number of sessions.

Use the following command to perform cluster session synchronization using the port10 and port12 interfaces.

config system ha
set session-sync-dev port10 port12

end

Session synchronization packets use Ethertype 0x8892. The interfaces to use for session synchronization must
be connected together either directly using the appropriate cable (possible if there are only two units in the
cluster) or using switches. If one of the interfaces becomes disconnected the cluster uses the remaining
interfaces for session synchronization. If all of the session synchronization interfaces become disconnected,
session synchronization reverts back to using the HA heartbeat link. All session synchronization traffic is between
the primary unit and each subordinate unit.

Since large amounts of session synchronization traffic can increase network congestion, it is recommended that
you keep this traffic off of your network by using dedicated connections for it.
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Note that unsetting session-sync-dev (i.e. by entering unset session-
syn-dev) has the following two effects:

1. Session synchronization will use the ports defined as HA heartbeat interfaces (set
hbdev).

2. Session synchronization packets will be sent over UDP/708 instead of Ethertype
0x8892.

NAT session synchronization

NAT sessions are not synchronized by default. You can enable NAT session synchronization by entering the
following command:

config system ha
set session-pickup enable
set session-pickup-nat enable

end

Note that, after a failover with this configuration, all sessions that include the IP addresses of interfaces on the
failed FortiGate unit will have nowhere to go since the IP addresses of the failed FortiGate unit will no longer be
on the network. If you want NAT sessions to resume after a failover you should not configure NAT to use the
destination interface IP address, since the FGSP FortiGate units have different IP addresses. To avoid this issue,
you should use IP pools with the type set to overload (which is the default IP pool type), as shown in the
example below:

config firewall ippool
edit FGSP-pool

set type overload
set startip 172.20.120.10
set endip 172.20.120.20

end

In NAT mode, only sessions for route mode security policies are synchronized. FGSP HA is also available for
FortiGate units or virtual domains operating in Transparent mode. Only sessions for normal Transparent mode
policies are synchronized.

IPsec tunnel synchronization

When you use the config system cluster-sync command to enable FGSP, IPsec keys and other
runtime data are synchronized between cluster units. This means that if one of the cluster units goes down the
cluster unit that is still operating can quickly get IPsec tunnels re-established without re-negotiating them.
However, after a failover, all existing tunnel sessions on the failed FortiGate have to be restarted on the still
operating FortiGate.

IPsec tunnel sync only supports dialup IPsec. The interfaces on both FortiGates that are tunnel endpoints must
have the same IP addresses and external routers must be configured to load balance IPsec tunnel sessions to the
FortiGates in the cluster.

Standalone configuration synchronization uses a very similar process as FGCP. There is a similar relationship
between the two FortiGates but only in regards to configuration synchronization, not session information. The
primary unit is selected by using priority/override. The heartbeat is used to check the primary unit's health. Once
heartbeat loss is detected, a new primary unit is selected.
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Automatic session synchronization after peer reboot

The following command allows you to configure an automatic session synchronization after a peer FGSP unit has
rebooted. FGSPwill send out heartbeat signals (every 1 - 10 seconds, as shown below) if one FortiGate is
rebooting and the other FortiGate fails.

To configure automatic session synchronization:

config system session-sync
edit 1

set down-intfs-before-sess-sync <interfaces> - List of interfaces to be turned down before session
synchronization is complete.

set-hb-interval <integer> - (1 - 10 seconds)
set hb-lost-threshold <integer> - (1 - 10)

next
end

1341 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



FGFM - FortiGate to FortiManager Protocol

The FortiGate to FortiManager (FGFM) protocol is designed for FortiGate and FortiManager deployment
scenarios, especially where NAT is used. These scenarios include the FortiManager on public internet while the
FortiGate unit is behind NAT, FortiGate unit is on public internet while FortiManager is behind NAT, or both
FortiManager and FortiGate unit have routable IP addresses.

The FortiManager unit's Device Manager uses FGFM to create new device groups, provision and add devices,
and install policy packages and device settings.

Port 541 is the default port used for FortiManager traffic on the internal management network. Port 542 is also
used to establish IPv6 connection.

Adding a FortiGate to the FortiManager

Adding a FortiGate unit to a FortiManager requires configuration on both devices. This section describes the
basics to configure management using a FortiManager device.

FortiGate configuration

Adding a FortiGate unit to FortiManager will ensure that the unit will be able to receive antivirus and IPS updates
and allow remote management through the FortiManager system, or FortiCloud service. The FortiGate unit can
be in either NAT or transparent mode. The FortiManager unit provides remote management of a FortiGate unit
over TCP port 541.

You must first enable Central Management on the FortiGate so management updates to firmware and
FortiGuard services are available:

1. Go to System > Settings.
2. Set Central Management to FortiManager.
3. Enter the FortiManager's IP/Domain Name in the field provided, and select Send Request.

You can also select Registration Password and enter a password to connect to the FortiManager.

To configure the previous steps in the CLI, enter the following - note that fmg can be set to either an IP address
or FQDN:

config system central-management
set fmg <string>

end

To use the registration password, enter the following:

execute central-mgmt register-device <fmg-serial-no> <fmg-register-password> <fgtusrname>
<fgt-password>

FGFM is also used in ADOMs (Administrative Domains) set to Normal Mode. Normal Mode has Read/Write
privileges, where the administrator is able to make changes to the ADOM and manage devices from the
FortiManager. FortiGate units in the ADOM will query their own configuration every five seconds. If there has
been a configuration change, the FortiGate unit will send a revision on the change to the FortiManager using the
FGFM protocol.

To configure central management on the FortiGate unit, enter the following on the FortiGate:

config system central-management
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set mode normal
set fortimanager-fds-override enable
set fmg <string>

end

Configuring an SSL connection

The default encryption automatically sets high and medium encryption algorithms. Algorithms used forHigh,
Medium, and Low follow the openssl definitions below:

Encryption level Key strength Algorithms used

High Key lengths larger than 128
bits, and some cipher suites
with 128-bit keys.

DHE-RSA-AES256-SHA:AES256-SHA: EDH-RSA-
DES-CBC3-SHA: DES-CBC3-SHA:DES-CBC3-
MD5:DHE-RSA-AES128-SHA:AES128-SHA

Medium Key strengths of 128 bit
encryption.

RC4-SHA:RC4-MD5:RC4-MD

Low Key strengths of 64 or 56 bit
encryption algorithms but
excluding export cipher suites.

EDH-RSA-DES-CDBC-SHA; DES-CBC-SHA; DES-
CBC-MD5

An SSL connection can be configured between the two devices and an encryption level selected. To configure the
connection in the CLI, Enter the following:

config system central-management
set status enable
set enc-algorithm {default | high | low}

end

Note that default automatically sets high and medium encryption algorithms.

FortiManager configuration

Use the Device Manager pane to add, configure, and manage devices.

You can add existing operational devices, unregistered devices, provision new devices, and add multiple devices
at a time.

Adding an operating FortiGate HA cluster to the Device Manager pane is similar to adding a standalone device.
Type the IP address of the master device. The FortiManager will handle the cluster as a single managed device.

To confirm that a device model or firmware version is supported by current firmware
version running on FortiManager, enter the following CLI command:

diagnose dvm supported-platforms list

Replacing a FortiGate in a FortiManager configuration

FGFM can be used in order to re-establish a connection between a FortiGate unit and a FortiManager
configuration. This is useful for if you need a FortiGate unit replaced following an RMA hardware replacement.
This applies to a FortiGate running in HA as the primary units; it does not apply to subordinate units.
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When the FortiGate unit is replaced, perform a Device Manager Connectivity check or Refresh on teh
FortiManager to establish the FGFM management tunnel to the FortiGate. If it fails, to establish, you can force
the tunnel by executing the following command on the FortiManager:

execute fgfm reclaim-dev-tunnel <device_name>

Debugging FGFM on FortiManager

l To display diagnostic information for troubleshooting (Set the debug level of FGFM daemon. Enter a device name
to only show messages related to that device):

diagnose debug application fgfmsd <integer> <device_name>

l To view installation session, object, and session lists:

diagnose fgfm install-session
diagnose fgfm object-list
diagnose fgfm session-list <device_ID>

l To reclaim a management tunnel (device name is optional):

execute fgfm reclaim-dev-tunnnel <device_name>

l To view the link-local address assigned to the FortiManager:

diagnose fmnetwork interface list

Debugging FGFM on FortiGate

l To view information about the Central Management System configuration:

get system central-management

l To produce realtime debugging information:

diagnose debug application fgfmd -1

l To view the link-local address assigned to the FortiManager:

diagnose fmnetwork interface list
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The Session-aware Load Balancing Cluster (SLBC) protocol is used for clusters consisting of FortiControllers that
perform load balancing of both TCP and UDP sessions. As session-aware load balancers, FortiControllers, with
FortiASIC DP processors, are capable of directing any TCP or UDP session to any worker installed in the same
chassis. It also means that more complex networking features such as NAT, fragmented packets, complex UDP
protocols and others such as Session Initiation Protocol (SIP), a communications protocol for signaling and
controlling multimedia communication sessions, can be load balanced by the cluster.

Currently, only three FortiController models are available for SLBC: FortiController-5103B, FortiController-
5903C, and FortiController-5913C. Supported workers include the FortiGate-5001B, 5001C, 5101C, and 5001D.

FortiGate-7000 series products also support SLBC.

You cannot mix FGCP and SLBC clusters in the same chassis.

An SLBC with two FortiControllers can operate in active-passive mode or dual mode. In active-passive mode, if
the active FortiController fails, traffic is transferred to the backup FortiController. In dual mode both
FortiControllers load balance traffic and twice as many network interfaces are available.

SLBC clusters consisting of more than one FortiController use the following types of communication between
FortiControllers to operate normally:
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l Heartbeat: Allows the FortiControllers in the cluster to find each other and share status information. If a
FortiController stops sending heartbeat packets it is considered down by other cluster members. By default
heartbeat traffic uses VLAN 999.

l Base control:Communication between FortiControllers on subnet 10.101.11.0/255.255.255.0 using VLAN 301.
l Base management:Communication between FortiControllers on subnet 10.101.10.0/255.255.255.0 using

VLAN 101.
l Session synchronization: If one FortiController fails, session synchronization allows another to take its place and

maintain active communication sessions. FortiController-5103B session sync traffic uses VLAN 2000.
FortiController-5903C and FortiController-5913C session sync traffic between the FortiControllers in slot 1 uses
VLAN 1900 and between the FortiControllers in slot 2 uses VLAN 1901. You cannot change these VLANs.

Note that SLBC does not support session synchronization between workers in the same chassis. The
FortiControllers in a cluster keep track of the status of the workers in their chassis and load balance sessions to
the workers. If a worker fails the FortiController detects the failure and stops load balancing sessions to that
worker. The sessions that the worker is processing when it fails are lost.

Changing the heartbeat VLAN

To change the VLAN from the FortiController GUI, from the System Information dashboard widget, beside HA
Status, select Configure. Change the VLAN to use for HA heartbeat traffic(1-4094) setting.

You can also change the heartbeat VLAN ID from the FortiController CLI. For example, to change the heartbeat
VLAN ID to 333, enter the following:

config system ha
set hbdev-vlan-id 333

end

Setting the mgmt interface as a heartbeat interface

To add the mgmt interface to the list of heartbeat interfaces used, on the FortiController-5103B, enter the
following:

config system ha
set hbdev b1 b2 mgmt

end

This example adds the mgmt interface for heartbeats to the B1 and B2 interfaces. The B1 and B2 ports are
recommended because they are 10G ports and the Mgmt interface is a 100Mb interface.

FortiController-5103B is currently the only model that allows its mgmt interface to be
added to the heartbeat interfaces list.

Changing the heartbeat interface mode

By default, only the first heartbeat interface (usually B1) is used for heartbeat traffic. If this interface fails on any
of the FortiControllers in a cluster, then the second heartbeat interface is used (B2).

To simultaneously use all heartbeat interfaces for heartbeat traffic, enter the following command:

config load-balance-setting
set base-mgmt-interface-mode active-active

end
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Changing the base control subnet and VLAN

You can change the base control subnet and VLAN from the FortiController CLI. For example, to change the base
control subnet to 10.122.11.0/255.255.255.0 and the VLAN ID to 320, enter the following:

config load-balance setting
set base-ctrl-network 10.122.11.0 255.255.255.0

config base-ctrl-interfaces
edit b1
set vlan-id 320
next
edit b2
set vlan-id 320

end

Changing the base management subnet and VLAN

You can change the base management subnet from the FortiController GUI under Load Balance > Config and
changing the Internal Management Network.

You can also change the base management subnet and VLAN ID from the FortiController CLI. For example, to
change the base management subnet to 10.121.10.0/255.255.255.0 and the VLAN to 131, enter the following:

config load-balance setting
set base-mgmt-internal-network 10.121.10.0 255.255.255.0

config base-mgt-interfaces
edit b1
set vlan-id 131
next
edit b2
set vlan-id 131

end

If required, you can use different VLAN IDs for the B1 and B2 interface.

Changing this VLAN only changes the VLAN used for base management traffic between chassis. Within a chassis
the default VLAN is used.

Enabling and configuring the session sync interface

To enable session synchronization in a two chassis configuration, enter the following command:

config load-balance setting
set session-sync enable

end

You will then need to select the interface to use for session sync traffic. The following example sets the
FortiController-5103B session sync interface to F4:

config system ha
set session-sync-port f4

end

The FortiController-5903C and FortiController-5913C use b1 and b2 as the session sync interfaces so no
configuration changes are required.

FGCP to SLBC migration

You can convert a FGCP virtual cluster (with VDOMs) to an SLBC cluster. The conversion involves replicating the
VDOM, interface, and VLAN configuration of the FGCP cluster on the SLBC cluster primary worker, then backing
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up the configuration of each FGCP cluster VDOM. Each of the VDOM configuration files is manually edited to
adjust interface names. These modified VDOM configuration files are then restored to the corresponding SLBC
cluster primary worker VDOMs.

For this migration to work, the FGCP cluster and the SLBC workers must be running the same firmware version,
the VDOMS are enabled on the FGCP cluster, and the SLBC workers have been registered and licensed.
However, the FGCP cluster units do not have to be the same model as the SLBC cluster workers.

Only VDOM configurations are migrated. You have to manually configure primary worker management and
global settings.

Conversion steps

1. Add VDOM(s) to the SLBC primary worker with names that match those of the FGCP cluster.
2. Map FGCP cluster interface names to SLBC primary worker interface names. For example, you can map the

FGCP cluster port1 and port2 interfaces to the SLBC primary worker fctl/f1 and fctl/f2 interfaces. You can also
map FGCP cluster interfaces to SLBC trunks, and include aggregate interfaces.

3. Add interfaces to the SLBC primary worker VDOMs according to your mapping. This includes moving SLBC
physical interfaces into the appropriate VDOMs, creating aggregate interfaces, and creating SLBC trunks if
required.

4. Add VLANs to the SLBC primary worker that match VLANs in the FGCP cluster. They should have the same
names as the FGCPVLANs, be added to the corresponding SLBC VDOMs and interfaces, and have the same
VLAN IDs.

5. Add inter-VDOM links to the SLBC primary worker that match the FGCP cluster.
6. Backup the configurations of each FGCP cluster VDOM, and SLBC primary worker VDOM.
7. Use a text editor to replace the first four lines of each FGCP cluster VDOM configuration file with the first four lines

of the corresponding SLBC primary worker VDOM configuration file. Here are example lines from an SLBC primary
worker VDOM configuration file:

#config-version=FG-5KB-5.02-FW-build670-150318:opmode=0:vdom=1:user=admin
#conf_file_ver=2306222306838080295
#buildno=0670
#global_vdom=0:vd_name=VDOM1

8. With the text editor, edit each FGCP cluster VDOM configuration file and replace all FGCP cluster interface
names with the corresponding SLBC worker interface names, according to the mapping you created in step 2.

9. Set up a console connection to the SLBC primary worker to check for errors during the following steps.
10. From the SLBC primary worker, restore each FGCP cluster VDOM configuration file to each corresponding SLBC

primary worker VDOM.
11. Check the following on the SLBC primary worker:

l Make sure set type fctrl-trunk is enabled for SLBC trunk interfaces.
l Enable the global and management VDOM features that you need, including SNMP, logging, connections to

FortiManager, FortiAnalyzer, and so on.
l If there is a FortiController in chassis slot 2, make sure the worker base2 interface status is up.
l Remove snmp-index entries for each interface.
l Since you can manage the workers from the FortiController you can remove management-related

configurations using the worker mgmt1 and mgmt2 interfaces (Logging, SNMP, admin access, etc.) if you are
not going to use these interfaces for management.
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How to set up SLBC with one FortiController-5103B

This example describes the basics of setting up a Session-aware Load Balancing Cluster (SLBC) that consists of
one FortiController-5103B, installed in chassis slot 1, and three FortiGate-5001C workers, installed in chassis
slots 3, 4, and 5.

This SLBC configuration can have up to eight 10Gbit network connections.

Configuring the hardware

1. Install a FortiGate-5000 series chassis and connect it to power. Install the FortiController in slot 1. Install the
workers in slots 3, 4, and 5. Power on the chassis.

2. Check the chassis, FortiController, and FortiGate LEDs to verify that all components are operating normally. (To
check normal operation LED status see the FortiGate-5000 series documents available here.)

3. Check the FortiSwitch-ATCA release notes and install the latest supported firmware on the FortiController and on
the workers. Get FortiController firmware from the Fortinet Support site. Select the FortiSwitch-ATCA product.

Configuring the FortiController

To configure the FortiController, you will need to either connect to the FortiController GUI or CLI with the default
IP address of http://192.168.1.99. Log in using the admin account (no password).

1. Add a password for the admin account. Use the Administratorswidget in the GUI, or enter the following CLI
command:
config admin user

edit admin
set password <password>

end

2. Change the FortiController mgmt interface IP address. Use theManagement Portwidget in the GUI, or enter the
following CLI command:
config system interface

edit mgmt
set ip 172.20.120.151/24

end

3. If you need to add a default route for the management IP address, enter the following command:
config route static

edit route 1
set gateway 172.20.121.2

end

4. To set the chassis type that you are using, enter the following CLI command:
config system global

set chassic-type fortigate-5140
end

5. Go to Load Balance > Config and add workers to the cluster by selecting Edit and moving the slots that contain
workers to theMember list. The Config page shows the slots in which the cluster expects to find workers. Since
the workers have not been configured yet, their status isDown.
Configure the External Management IP/Netmask. Once the workers are connected to the cluster, you can use
this IP address to manage and configure them.

6. You can also enter the following CLI command to add slots 3, 4, and 5 to the cluster:
config load-balance setting

config slots
edit 3
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next
edit 4

next
edit 5

end
end

7. You can also enter the following command to configure the external management IP/Netmask and management
access to the following address:
config load-balance setting

set base-mgmt-external-ip 172.20.120.100 255.255.255.0
set base-mgmt-allowaccess https ssh ping

end

Adding the workers

Before you begin adding workers to the cluster, make sure you enter the execute factoryreset command
in the CLI so the workers are set to factory default settings. If the workers are going to run FortiOS Carrier, add
the FortiOS Carrier licence instead - this will reset the worker to factory default settings.

Also make sure to register and apply licenses to each worker, including FortiClient licensing, FortiCloud
activation, and entering a license key if you purchased more than 10 Virtual Domains (VDOMs). You can also
install any third-party certificates on the primary worker before forming the cluster. Once the cluster is formed,
third-party certificates are synchronized to all of the workers. FortiToken licenses can be added at any time, which
will also synchronize across all of the workers.

1. Log in to each of the worker's CLI and enter the following CLI command to set the worker to operate in
FortiController mode:
config system elbc

set mode fortincontroller
end

Once the command is entered, the worker restarts and joins the cluster.

2. On the FortiController, go to Load Balance > Status. You will see the workers appear in their appropriate slots.
The worker in the lowest slot number usually becomes the primary unit.

You can now manage the workers in the same way as you would manage a standalone FortiGate. You can
connect to the worker GUI or CLI using the External Management IP. If you had configured the worker mgmt1
or mgmt2 interfaces you can also connect to one of these addresses to manage the cluster.

To operate the cluster, connect networks to the FortiController front panel interfaces and connect to a worker GUI
or CLI to configure the workers to process the traffic they receive. When you connect to the External Management
IP you connect to the primary worker. When you make configuration changes they are synchronized to all workers
in the cluster.

Managing the devices in an SLBC with the external management IP

The External Management IP address is used to manage all of the individual devices in a SLBC by adding a
special port number. This special port number begins with the standard port number for the protocol you are using
and is followed by two digits that identify the chassis number and slot number. The port number can be
calculated using the following formula:

service_port x 100 + (chassis_id - 1) x 20 + slot_id

Where:
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l service_port is the normal port number for the management service (80 for HTTP, 443 for HTTPS and so on).
l chassis_id is the chassis ID specified as part of the FortiController HA configuration and can be 1 or 2.
l slot_id is the number of the chassis slot.

By default, chassis 1 is the primary chassis and chassis 2 is the backup chassis.
However, the actual primary chassis is the one with the primary FortiController, which
can be changed independently of the chassis number. Additionally, the chassis_id is
defined by the chassis number, not whether the chassis contains the primary
FortiController.

Some examples:

l HTTPS, chassis 1, slot 2: 443 x 100 + (1 - 1) x 20 + 2 = 44300 + 0 + 2 = 44302:

browse to: https://172.20.120.100:44302

l HTTP, chassis 2, slot 4: 80 x 100 + (2 - 1) x 20 + 4 = 8000 + 20 + 4 = 8024:

browse to http://172.20.120.100/8024

l HTTPS, chassis 1, slot 10: 443 x 100 + (1 - 1) x 20 + 10 = 44300 + 0 + 10 = 44310:

browse to https://172.20.120.100/44310

Single chassis or chassis 1 special management port numbers

Slot number HTTP (80) HTTPS (443) Telnet (23) SSH (22) SNMP (161)

Slot 1 8001 44301 2301 2201 16101

Slot 2 8002 44302 2302 2202 16102

Slot 3 8003 44303 2303 2203 16103

Slot 4 8004 44304 2304 2204 16104

Slot 5 8005 44305 2305 2205 16105

Slot 6 8006 44306 2306 2206 16106

Slot 7 8007 44307 2307 2207 16107

Slot 8 8008 44308 2308 2208 16108

Slot 9 8009 44309 2309 2209 16109

Slot 10 8010 44310 2310 2210 16110

Slot 11 8011 44311 2311 2211 16111

Slot 12 8012 44312 2312 2212 16112
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Slot number HTTP (80) HTTPS (443) Telnet (23) SSH (22) SNMP (161)

Slot 13 8013 44313 2313 2213 16113

Slot 14 8014 44314 2314 2214 16114

Chassis 2 special management port numbers

Slot number HTTP (80) HTTPS (443) Telnet (23) SSH (22) SNMP (161)

Slot 1 8021 44321 2321 2221 16121

Slot 2 8022 44322 2322 2222 16122

Slot 3 8023 44323 2323 2223 16123

Slot 4 8024 44324 2324 2224 16124

Slot 5 8025 44325 2325 2225 16125

Slot 6 8026 44326 2326 2226 16126

Slot 7 8027 44327 2327 2227 16127

Slot 8 8028 44328 2328 2228 16128

Slot 9 8029 44329 2329 2229 16129

Slot 10 8030 44330 2330 2230 16130

Slot 11 8031 44331 2331 2231 16131

Slot 12 8032 44332 2332 2232 16132

Slot 13 8033 44333 2333 2233 16133

Slot 14 8034 44334 2334 2234 16134

For more detailed information regarding FortiController SLBC configurations, see the FortiController
documentation.
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Fortinet Security Fabric

Security Fabric spans across an entire network linking different security sensors and tools together to collect,
coordinate, and respond to malicious behavior in real time. Security Fabric can be used to coordinate the
behavior of different Fortinet products in your network, including FortiGate, FortiAnalyzer, FortiClient,
FortiSandbox, FortiAP, FortiSwitch, and FortiClient Enterprise Management Server (EMS). Security Fabric
supports FortiOS 5.4.1+, FortiSwitchOS 3.3+, and FortiClient 5.4.1+.

Port TCP/8009 is the port FortiGate uses for incoming traffic from the FortiClient Portal, as user information
(such as IP address, MAC address, avatar, and other profile information) is automatically synchronized to the
FortiGate and EMS.

The brief example below assumes that FortiTelemetry has been enabled on the top-level FortiGate (FGT1),
OSPF routing has been configured, and that policies have been created for all FortiGate units to access the
Internet.

For more details on how to configure a security fabric between FortiGate units, see Fortinet Security Fabric
installation on the Fortinet Cookbook website.

Enabling Security Fabric on the FortiGate:

1. On the upstream FortiGate (FGT1), go to Security Fabric > Settings and enable FortiGate Telemetry.
2. Enter aGroup name andGroup password for the fabric.
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3. On a downstream FortiGate (such as FGT2 or FGT3), configure the same fabric settings as were set on FGT1.
4. Enable Connect to upstream FortiGate.

Be sure you do not enable this on the topmost-level FortiGate (in this example, FGT1).
5. In FortiGate IP, enter the FGT1 interface that has FortiTelemetry enabled. The FortiTelemetry port (set to

8013) can be changed as required.

Once set up, you can view your network's Security Fabric configuration under FortiView through two
topology dashboards.

6. On top-level FortiGate, go to Security Fabric > Physical Topology. This dashboard shows a vizualization of all
access layer devices in the fabric.

7. Go to Security Fabric > Logical Topology to view information about the interfaces (logical or physical) that
each device in the fabric is connected to.

Other Security Fabric configurations for your network are available through the Fortinet Cookbook Security Fabric
Collection page.
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FortiTelemetry/On-Net/FortiClient Endpoint Compliance

FortiTelemetry (called FortiHeartBeat in FortiOS 5.4.0 and FortiClient Access in FortiOS 5.2) is an interface
option that listens for connections from devices with FortiClient installed. 

FortiTelemetry is the TCP/8013 protocol used between FortiClient and FortiGate, FortiClient and FortiClient
EMS, and between FortiGate and other FortiGates in CSF configurations.

While all GUI references of FortiHeartBeat have been changed to FortiTelemetry in
FortiOS 5.4.1, the CLI options have not been renamed and will remain as
fortiheartbeat.

With FortiTelemetry enabled on the FortiGate, you can enforce FortiTelemetry for all FortiClients. This
FortiClient endpoint compliance will require all clients to have FortiClient installed in order to get access through
the FortiGate. Configure these settings in the internal interface underNetwork > Interfaces. Edit the interface
of your choice. UnderRestrict Access > Administrative Access, enable FortiTelemetry, then enable
FortiClient On-Net Status.

CLI command - To enable FortiTelemetry on an interface:

config system interface edit <port_number>
set listen-forticlient-connection enable
set endpoint-compliance enable

end

You can also enable DHCP server and FortiClient On-Net Status to display the on-net status of FortiClient
devices on the FortiClient Monitor (underMonitor > FortiClient Monitor).

CLI command - To enable FortiClient On-Net status for a DHCP server added to the port1 interface:

config system dhcp server edit 1
set interface port1
set forticlient-on-net-status enable

end

FortiClient endpoint licence updates

FortiClient endpoint licenses for FortiOS 5.6.0 can be purchased in multiples of 100. There is a maximum client
limit based on the FortiGate's model. FortiCare enforces the maximum limits when the customer is applying the
license to a model.

If you are using the ten free licenses for FortiClient, support is provided on the Fortinet Forum
(forum.fortinet.com). Phone support is only available for paid licenses.

Model(s) Maximum client limit

VM00 200

FGT/FWF 30 to 90 series 200
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Model(s) Maximum client limit

FGT 100 to 400 series 600

FGT 500 to 900 series, VM01, VM02 2,000

FGT 1000 to 2900 series 20,000

FGT 3000 to 3600 series, VM04 50,000

FGT 3700D and above, VM08 and above 100,000

Older FortiClient SKUs will still be valid and can be applied to FortiOS 5.4 and 5.6.

Connecting FortiClient Telemetry after installation

After FortiClient is installed on an endpoint, FortiClient automatically launches and searches for a FortiGate or
FortiClient EMS for FortiClient Telemetry connection. When FortiClient locates a FortiGate or EMS, the
FortiGate Detected or Enterprise Management Server (EMS) Detected dialog box will appear:

If all the information displayed is correct, select Accept. FortiClient Telemetry will connect to the identified
FortiGate/EMS.

Alternately, you can select Cancel and launch FortiClient without connecting to FortiClient Telemetry. This will
launch FortiClient is standalone mode, where you can manually connect FortiClient Telemetry.

After FortiClient Telemetry is connected to FortiGate or EMS, FortiClient downloads a profile from
FortiGate/EMS.

How FortiClient locates FortiGate/EMS

FortiClient uses the following methods in the following order to automatically locate FortiGate/EMS for Telemetry
connection:
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1. Telemetry gateway IP list: FortiClient Telemetry searches for IP addresses in its subnet in the Gateway IP list.
It connects to the FortiGate in the list that is also in the same subnet as the host system.
If FortiClient cannot find any FortiGates in its subnet, it will attempt to connect to the first reachable
FortiGate in the list, starting from the top. The order of the list is maintained as it was configured in the
Gateway IP list.

2. Remembered gateway IP list: You can configure FortiClient to remember gateway IP addresses when you
connect Telemetry to FortiGate/EMS. Later FortiClient can use the remembered IP addresses to automatically
connect Telemetry to FortiGate/EMS.

3. Default gateway IP address: The default gateway IP address is specified on the FortiClient endpoint and is
used to automatically connect to FortiGate. This method does not support connection to EMS.

FortiClient obtains the default gateway IP address from the operating system on the
endpoint device. The default gateway IP address of the endpoint device should be the
IP address for the FortiGate interface with Telemetry enabled.

If FortiClient is unable to automatically locate a FortiGate/EMS on the network for Telemetry connection, you can
type the gateway IP address of the FortiGate/EMS.

FortiClient uses the same process to connect Telemetry to FortiGate/EMS after the
FortiClient endpoint reboots, rejoins the network, or encounters a network change.
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FortiGuard services can be purchased and registered to your FortiGate unit. The FortiGate must be connected to
the Internet in order to automatically connect to the FortiGuard Distribution Network (FDN) to validate the license
and download FDN updates.

The FortiGuard subscription update services include:

l AntiVirus (AV)
l Intrusion Protection Service (IPS)
l Application Control
l Anti-Spam
l Web Filtering
l Web Application Firewall (WAF)

The FDN sends notice that a FortiGuard AntiVirus and IPS update is available on UDP/9443.

The following information concerns certain considerations in regards to FortiGate receiving FortiGuard updates
through FDN, how the submission of malware statistics to FortiGuard is handled, an automatic update behaviour
when FortiGate has expired licenses, and related CLI commands.

Enabling FDN updates and FortiGuard services

In order to receive FortiGuard subscription updates, the unit needs to have access to the Internet and be able to
connect to a DNS server in order to resolve the following URLs:

l update.fortiguard.net: For AV and IPS updates
l service.fortiguard.net: For web filtering and anti-spam updates
l support.fortinet.com

1. Go to System > FortiGuard. UnderAntiVirus & IPS Updates, enable Scheduled Updates, and configure an
update schedule.

2. You can force the unit to connect to the AV/IPS server by selecting Update AV & IPS Definitions.
3. You can view your subscription details above in the License Information table.
4. Once the schedule has been enabled, select Apply.
To see if the service is viable, open the CLI console and enter the following commands below.

For Web Filtering:

diagnose debug rating

For Anti-Spam:

diagnose spamfilter fortishield servers

If only one or two IPs are displayed in the command outputs, it could be one of the following issues:

l No response from the DNS server: Either the DNS server is unreachable or there is a problem with the routing.
Make sure that contact to the DNS server is available by resolving some URLs from the CLI, for example:

execute ping www.google.com
execute ping service.fortiguard.net

You can also
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l Review update errors: Review update information from the last update, enable debug outputs and force the
update:
diagnose test update info
diagnose debug enable
diagnose debug application update 255
execute update-ase
execute update-av
execute update-ips

After troubleshooting, it is highly recommended to turn off debug mode:

diagnose debug disable
diagnose debug application update 0

l FortiGuard Web filtering: Port blocking or packet inspection is occurring downstream. The default port used by
the FortiGuard for the FortiGuard services is 8888.

You can change this port using the following command:

config system fortiguard
set port <port_number>

end

You can also change the source port for management traffic with the following CLI command:

config system global
set ip-src-port-range 1035-25000

end
diagnose test application urlfilter 99
diagnose test application smtp 99

Submission of malware statistics to FortiGuard

FortiGates periodically send encrypted AntiVirus, IPS, and Application Control event statistics to FortiGuard.
Included with these malware statistics is the IP address and serial number of the FortiGate and the country in
which the FortiGate is located.

The statistics are used to improve various aspects of FortiGate malware protection. For example, AntiVirus
statistics allow FortiGuard to determine the viruses that are active in the wild. Signatures for such viruses are kept
in the Active AV Signature Database that is used by many Fortinet products. Signatures for inactive viruses are
moved to the Extended/Extreme AV Signature Database used by some customers. If the events for inactive
viruses start appearing in malware statistics, these signatures can be moved back to the Active AV Signature
Database.

The FortiGate and FortiGuard servers go through a 2-way SSL/TLS 1.2 authentication before any data is
transmitted. The certificates used in this process must be trusted by each other and signed by Fortinet CA server.

Malware statistics are accumulated and sent periodically (by default every 60 minutes).

Fortinet products can only accept data from authorized FortiGuard severs. Fortinet products use DNS to find
FortiGuard servers and periodically update their FortiGate server list. All other servers are provided by a list that is
updated through the encrypted channel.
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The submission of malware data is in accordance with Fortinet's “Automatically-
Collected Information” detailed in the Fortinet Privacy Policy, and the purpose of this
collection is outlined in the “Use of your Information” section of the privacy policy.

There is no sensitive or personal information included in these submissions. Only
malware statistics are sent.

Fortinet uses the malware statistics collected in this manner to improve the
performance of the FortiGate services and to display statistics on Fortinet's Support
site for customers registered FortiGate devices.

Fortinet may also publish or share statistics or results derived from this malware data
with various audiences. The malware statistics shared in this way do not include any
customer data.

To enable, disable, and/or customize how often statistics are sent to FortiGuard, use the following command:

CLI syntax

config system global
set fds-statistics {enable | disable}
set fds-statistics-period <minutes>

end

In addition to secure submission of statistics to FortiGuard, there are other mechanisms in place to prevent
unauthorized FortiGuard updates from clients:

l The server certificate has to be authenticated by FortiGates, and it only trusts Fortinet's root certificate.
l Proprietary encryption (including FCP, an application-level proprietary protocol) that only Fortinet's own

servers/devices can prepare.

FortiGates can only accept data from Fortinet's own list of servers, although the list can be updated through
previously connected servers. DNS is used on the initial server, but all other servers are provided by a list that is
updated through SSL, meaning that only FortiGates accept data from those servers.

Automatic update at every GUI login

FortiGates running FortiOS 5.6.1 and above may perform automatic "update now" updates when one of the
"core" licenses is unavailable: Application Control, IPS, or AntiVirus. Please note that this automatic update is
triggered even if the following CLI command is set:

config system autoupdate schedule
set status disable

end

CLI syntax

The following section contains commands to control FortiGuard.

system autoupdate push-update

The following command will set the FDN push update port.

config system.autoupdate push-update
set port <integer>

end
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system autoupdate tunneling

The following command will set the proxy server port that the FortiGate will use to connect to the FortiGuard
Distribution Network (FDN).

config system.autoupdate tunneling
set port <integer>

end

system fortiguard

The following command will set the port by which scheduled FortiGuard service updates will be received.

config system fortiguard
set port {53 | 8888 | 80}

end

webfilter fortiguard

The following command will close ports used for HTTPS/HTTP override authentication and disable user
overrides:

config webfilter fortiguard
set close-ports {enable | disable}

end

For more information, including FortiGuard execute commands used to manage FortiCloud domains and
operations, see the CLI Reference.
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FortiLink

FortiGate units can be used to remotely manage FortiSwitch units, which is also known as using a FortiSwitch in
FortiLink mode. FortiLink defines the management interface and the remote management protocol between the
FortiGate and FortiSwitch.

Different FortiGate models support remote management for varying numbers of FortiSwitches, as shown below:

FortiGate Number of FortiSwitches

Up to FortiGate 98 and FortiGate VM01 8

FortiGate 100 to 280 and FortiGate VM02 24

FortiGate 300 to 5xx 48

FortiGate 600 to 900 and FortiGate VM04 64

FortiGate 1000 and up 128

FortiGate-3000 and up, and FortiGate VM08 and up 256

Supported FortiSwitch models

The following table shows the FortiSwitch models that support FortiLink mode when paired with the
corresponding FortiGate models and the listed minimum software releases.

FortiSwitch FortiGate Earliest FortiSwitchOS Earlist FortiOS

FS-224D-POE FGT-90D (Wifi/POE) 3.0.0 5.2.2

FS-108D-POE FGT-60D (all) 3.0.1 5.2.3

FSR-112D-POE FGR-90D 3.0.1 5.2.3

FS-124D FGT-90D + FGT-60D 3.0.1 5.2.3

FS-124D-POE FGT-90D + FGT-60D 3.0.1 5.2.3

FS-224D-FPOE FGT-90D + FGT-60D 3.0.1 5.2.3

Note that all FortiSwitches above also support FortiLink mode when paired with the following FortiGate
models: 100D, 140D (POE, T1), 200D, 240D, 280D (POE), 600C, 800C, and 1000C.

FortiLink ports for each FortiSwitch model

Each FortiSwitch model provides one designated port for the FortiLink connection. The table below lists the
FortiLink port for each model:
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FortiSwitch model Port for FortiLink connection

FS-28C WAN port 1

FS-324B-POE Management Port

FS-448B (10G only) WAN port (uplink 1)

FS-348B Last port (port 48)

For all D-series switches, use the last (highest number) port for FortiLink. For example:

FS-108D-POE Last port (port 10)

FSR-112D-POE Last port (port 12)

FS-124D Last port (port 26). May require an SFPmodule.*

FS-224D-POE Last port (port 24)

FS-224D-FPOE Last port (port 28). May require an SFPmodule.*

* FortiSwitch 3.3.1 and later releases support the use of an RJ-45 port for FortiLink. Please contact Fortinet
Customer Service & Support for additional information.

FortiLink ports for each FortiGate model

The following table shows the ports for each model of FortiGate that can be FortiLink-dedicated.

FortiGate model Port for FortiLink connection

FGT-90D, FGT-90D-POE,
FWF-90D, FWF-90D-POE

port1 - port14

FGT-60D, FGT-60D-POE,
FWF-60D, FWF-60D-POE port1 - port7

FGT-100D port1 - port16

FGT-140D , 140D-POE,
140D-POE-T1 port1 - port36

FGT-200D port1 - port16

FGT-240D port1 - port40

FGT-280D, FGT-280D-POE port1 - port84

FGT-600C port3 - port22
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FortiGate model Port for FortiLink connection

FGT-800C port3 - port24

FGT-1000C port3 - port14, port23, port24

Auto-discovery of the FortiSwitch ports

In releases FortiSwitchOS 3.3.0 and beyond, the D-series FortiSwitch models support FortiLink auto-discovery,
which is automatic detection of the port connected to the FortiGate.

You can use any of the switch ports for FortiLink. Use the following FortiSwitch CLI commands to configure a port
for FortiLink auto-discovery:

config switch interface
edit <port>

set auto-discovery-fortilink enable
end

Note that some FortiSwitch ports are enabled for auto-discovery by default.

Each FortiSwitch model provides a set of ports that are enabled for FortiLink auto-discovery by default. If you
connect the FortiLink using one of these ports, no switch configuration is required.

In general (in FortiSwitchOS 3.4.0 and later releases), the last four ports are the default auto-discovery FortiLink
ports. The table below lists the default auto-discovery ports for each switch model:

FortiSwitch model Default auto-FortiLink ports

FS-108D ports 9 and 10

FSR-112D ports 9, 10, 11, and 12

FS-124D, FS-124D-POE ports 23, 24, 25, and 26

FS-224D-POE ports 21, 22, 23, and 24

FS-224D-FPOE ports 25, 26, 27, and 28

FS-248D-POE ports 49, 50, 51, and 52

FS-248D-FPOE ports 49, 50, 51, and 52

FS-424D, FS-424D-POE, FS-424D-FPOE ports 25 and 26

FS-448D, FS-448D-POE, FS-448D-FPOE ports 49, 50, 51, and 52

FS-524D, FS-524D-FPOE ports 25, 26, 27, 28, 29, and 30

FS-548D, FS-548D-FPOE ports 49, 50, 51, 52, 53, and 54

FS-1024D, FS-1048D, FS-3032D all ports
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You can also run the show switch interface CLI command on the FortiSwitch to see the ports that have
auto-discovery enabled.

Adding a managed FortiSwitch to the FortiGate

The following steps show how to add a new managed FortiSwitch using the FortiGate GUI or the CLI.

For FortiSwitchOS releases prior to 3.3.0, you must Set the FortiSwitch to remote
management mode before following the steps below.

Using the FortiGate GUI:

1. Connect a cable from the designated FortiSwitch port to an unused port on the FortiGate. Refer to FortiLink ports
for each FortiSwitch model for additional information.

2. Go to Network > Interfaces and edit an internal port on the FortiGate.
3. Set Addressing mode to Dedicated to FortiSwitch and select OK.
4. As of FortiOS 5.4.0, theManaged FortiSwitchGUI option can only be accessed by enabling it through the CLI

console.
Open the CLI console and enter the following command to make the switch controller available in the GUI,
and to set the reserved subnetwork for the controller:

config system global
set switch-controller enable
set switch-controller-reserved-network 169.254.254.0 255.255.255.0

end

5. Go toWiFI & Switch Controller > Managed FortiSwitch. The new FortiSwitch should now be displayed in the
table.

6. Right-click on the FortiSwitch and select Authorize.

Using the FortiGate CLI:

Note that, for the example shown below, the FortiGate's port1 is configured as the FortiLink port.

1. If required, remove port1 from the lan interface:
config system virtual-switch

edit lan
config port

delete port1
end

end
end

2. Configure the interface for port1:
config system interface

edit port1
set ip 172.20.120.10 255.255.255.0
set allowaccess capwap
set vlanforward enable

end
end

3. Configure an NTP server on port1:
config system ntp
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set server-mode enable
set interface port1

end

4. Authorize the FortiSwitch unit as a managed switch (note that that FortiSwitch will reboot once you issue the
command below):
config switch-controller managed-switch

edit FS224D3W14000370
set fsw-wan1-admin enable

end
end

5. Configure a DHCP server on port1:
config system dhcp server

edit 0
set netmask 255.255.255.252
set interface port1
config ip-range

edit 0
set start-ip 169.254.254.2
set end-ip 169.254.254.50

end
set vci-match enable
set vci-string FortiSwitch
set ntp-service local

end
end

Set the FortiSwitch to remote management mode

Use the FortiSwitch GUI or the CLI to set the remote management mode.

Note that the following steps are not necessary for FortiSwitchOS releases 3.3.0 or later.

Using the FortiSwitch GUI:

1. Go to System > Dashboard > Status and locate the System Information widget.
2. BesideOperation Mode, select Change.
3. ChangeManagement Mode to FortiGate Remote Management and select OK.
4. Awarning will appear asking if you wish to continue. Select OK.

Using the FortiSwitch CLI:

config system global
set switch-mgmt-mode fortilink

end

Configuring the FortiSwitch remote management port

If the FortiSwitch model has a dedicated management port, you can configure remote management to the
FortiSwitch. In FortiLink mode, the FortiGate is the default gateway, so you need to configure an explicit route for
the FortiSwitch management port.

To do this, from the FortiSwitch CLI, enter the following command:

config router static
edit 1
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set device mgmt
set gateway <router_IP_address>
set dst <router_subnet> <subnet_mask>

end
end

Configuring FortiLink LAG

Starting with FortiOS 5.4.0 and FortiSwitchOS 3.3.0, you can configure the Fortilink as a Link Aggregation Group
(LAG) to provide increased bandwidth between the FortiGate and FortiSwitch.

Connect any two ports on the FortiGate to two ports on the FortiSwitch. Make sure that you use the designated
Fortilink port as one of the ports on the switch.

To configure the Fortilink as a LAG on the FortiGate, create a trunk (of type fortilink) with the two ports that you
connected to the switch:

config system interface
edit "fortilink"

set vdom root
set allowaccess ping capwap http https
set type fortilink
set member port4 port5
set snmp-index 17
set lacp-mode static

next
end
config system ntp

set ntpsync enable
set syncinterval 60
set server-mode enable
set interface "fortilink"

end

There is no specific configuration required for the LAG on the switch.
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Multi-location organizations or businesses using the cloud can provide license-free WAN optimization using
FortiOS.

WAN Optimization is a comprehensive solution that maximizes your WAN performance and provides intelligent
bandwith management and unmatched consolidated security performance. WAN optimization reduces your
network overhead and removes unneccessary traffic for a better overall performance experience. Efficient use of
bandwidth and better application performance will remove the need for costly WAN link upgrades between data
centers and other expensive solutions for your network traffic growth.

WAN optimization is available on FortiGate models with internal storage that also support SSL acceleration.
Internal storage includes high-capacity internal hard disks, AMC hard disk modules, FortiGate Storage Modules
(FSMs) or over 4 GB of internal flash storage.

WAN optimization tunnels use port 7810.

The following features below are available through WAN optimization:

Protocol optimization

Protocol optimization is effective for applications designed for the LAN that do not function well on low
bandwidth, high latency networks. FortiOS protocol optimization improves the efficiency of CIFS, FTP, HTTP,
MAPI, and general TCP sessions.

CIFC, for example, requires many background transactions to successfully transfer a single file. When
transferring the file, CIFS sends small chunks of data and waits sequentially for each chunk’s arrival and
acknowledgment before sending the next chunk. This large amount of requests and acknowledgements of traffic
can delay transfers. WAN Optimization removes this complexity and improves the efficiency of transferring the
file.

TCP protocol optimization uses techniques such as SACK support, window scaling and window size adjustment,
and connection pooling to remove commonWAN TCP bottlenecks.
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Byte caching

Byte caching improves caching by accelerating the transfer of similar, but not identical content. Byte caching
reduces the amount of data crossing the WAN when multiple different emails with the same or similar
attachments or different versions of an attachment are downloaded from a corporate email server to different
locations over the WAN.

Byte caching breaks large units of application data, such as email attachments or file downloads, into smaller
chunks of data. Each chunk of data is labeled with a hash, and chunks with their respective hashes are stored in a
database on the local FortiGate unit. When a remote user requests a file, WAN optimization sends the hashes,
rather than the actual data. The FortiGate unit at the other end of the WAN tunnel reassembles the data from its
own hash database, only downloading the chunks it is missing. Deduplication, or the process of eliminating
duplicate data, will reduce space consumption.

Byte caching is not application specific, and assists by accelerating all protocols supported byWAN optimization.

Web caching

WAN optimization reduces download times of content from central files repositories through web caching.
FortiOSWeb caching stores remote files and web pages on local FortiGate devices for easy local access to
commonly accessed files. There is little impact on the WAN, resulting in reduced latency for those requesting the
files.

In addition, web caching also recognizes requests for Windows or MSOffice updates, and downloads the new
update file in the background. Once downloaded to the cache, the new update file is available to all users, and all
subsequent requests for this update are rapidly downloaded from the cache.

Traffic shaping

Controls data flow for specific applications, giving administrators the flexibility to choose which applications take
precedence over the WAN. A common use case of traffic shaping would be to prevent one protocol or application
from flooding a link over other protocols deemed more important by the administrator.
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SSL acceleration

SSL is used by many organizations to keep WAN communications private. WAN Optimization boosts SSL
acceleration properties of FortiGate FortiASIC hardware by accelerating SSL traffic across the WAN. The
FortiGate unit handles SSL encryption/decryption for corporate servers providing SSL encrypted connections over
the WAN.

Explicit web proxy server

Allows users on the internal network to browse the Internet through the explicit web proxy server.

Explicit FTP proxy server

Allows users on the internal network to access FTP servers through the explicit FTP proxy server.

Reverse proxy

The web and FTP proxies can be configured to protect access to web or FTP servers that are behind the
FortiGate using a reverse proxy configuration. Reverse proxies retrieve resources on behalf of a client from one or
more servers. These resources are then returned to the client as if they originated from the proxy server.

WCCP

The Web Cache Communication Protocol (WCCP) allows you to offload web caching to redundant web caching
servers. This traffic redirection helps to improve response time and optimize network resource usage.

WAN optimization and HA

You can configure WAN optimization on a FortiGate HA cluster. The recommended HA configuration for WAN
optimization is active-passive mode. Also, when the cluster is operating, all WAN optimization sessions are
processed by the primary unit only. Even if the cluster is operating in active-active mode, HA does not load-
balance WAN optimization sessions. HA also does not support WAN optimization session failover.

Configuring an explicit proxy with WAN optimization web caching

For this configuration, all devices on the wireless network will be required to connect to the proxy at port 8080
before they can browse the Internet. WAN optimization web caching is added to reduce the amount of Internet
bandwidth used and improve web browsing performance.

Enabling WAN optimization and configuring the explicit web proxy for the wireless interface

1. Go to System > Config > Features. Ensure that Explicit Proxy andWAN Opt & Cache are enabled.
2. Go to System > Network > Interfaces, edit the wireless interface and select Enable Explicit Web Proxy.
3. Go to System > Network > Explicit Proxy. Select Enable Explicit Web Proxy for HTTP/HTTPS. Make

sure that Default Firewall Policy Action is set to Deny.

Adding an explicit web proxy policy

1. Go to Policy & Objects > Policy > Explicit Proxy and create a new policy.
2. Set Explicit Proxy Type toWeb and theOutgoing Interface to the Internet-facing interface.
3. EnableWeb Cache.
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Configuring devices on the wireless network to use the web proxy

To use the web proxy, all devices on the wireless network must be configured to use the explicit proxy server. The
IP address of the server is the IP address of the FortiGate’s wireless interface (for example, 10.10.80.1) and the
port is 8080. Some browsers may have to be configured to use the device’s proxy settings.

For Windows Vista/7/8, open Internet Properties. Go to Connections > LAN Settings and enable and
configure the Proxy Server.

For Mac OS X, open Network Preferences > Wi-Fi > Advanced > Proxies. SelectWeb Proxy (HTTP) and
configure the proxy settings.

For iOS, go to Settings > Wi-Fi. Edit the wireless network. Scroll down to HTTP PROXY, select Manual, and
configure the proxy settings.

For Android, in WiFi network connection settings, edit the wireless network. Select Show advanced options,
configure aManual proxy, and enter the proxy settings.

Force HTTP and HTTPS traffic to use the web proxy

Block HTTP and HTTPS access to the Internet from the wireless network so that the only path to the Internet is
through the explicit proxy. You can edit or delete policies that allow HTTP or HTTPS access. You can also add a
policy to the top of the list that DeniesHTTP and HTTPS traffic.
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Fortinet Single Sign-On (FSSO), formerly known as FortiGate Server Authentication Extension (FSAE), is the
authentication protocol by which users can transparently authenticate to FortiGate, FortiAuthenticator, and
FortiCache devices. The FortiAuthenticator unit identifies users based on their authentication from a different
system, and can be authenticated via numerous methods:

l Users can authenticate through a web portal and a set of embeddable widgets.
l Users with FortiClient Endpoint Security installed can be automatically authenticated through the FortiClient SSO

Mobility Agent.
l Users authenticating against Active Directory can be automatically authenticated.
l RADIUS Accounting packets can be used to trigger an FSSO authentication.
l Users can be identified through the FortiAuthenticator API. This is useful for integration with third-party systems.

Below are the TCP/UDP ports used by the multiple FSSO modes:

Purpose Protocol/Port

LDAP group membership lookup (Global Catalog) TCP/3268

LDAP domain controller discovery and group membership lookup TCP/389

DC Agent keepalive and push logon info to CA UDP/8002

CA keepalive and push logon info to Fortigate TCP/8000

NTLM TCP/8000

CADNS UDP/53

Workstation check, polling mode (preferred method) TCP/445

Workstation check, polling mode (fallback method) TCP/135, TCP/139, UDP/137

Remote access to logon events TCP/445

Group lookup using LDAP TCP/389

Group lookup using LDAPwith global catalog TCP/3268

Group lookup using LDAPS TCP/636

Resolve FSSO server name UDP/53

Configuring the FortiAuthenticator

The FortiAuthenticator unit can be integrated with external network authentication systems, such as RADIUS,
LDAP, Windows AD, and FortiClients to poll user logon information and send it to the FortiGate unit.
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To configure FortiAuthenticator polling:

1. Go to Fortinet SSO Methods > SSO > General.
2. In the FortiGate section, leave Listening port set to 8000, unless your network requires you to change this. The

FortiGate unit must allow traffic on this port to pass through the firewall. Optionally, you can set the Login expiry
time (default is 480minutes, or eight hours). This is the length of time users can remain logged in before the
system logs them off automatically.

3. Select Enable authentication and enter the Secret key. Be sure to use the same secret key when configuring
the FSSO Agent on FortiGate units.

4. In the Fortinet Single Sign-On (FSSO) section, enter the following information:

Enable Windows event log
polling (e.g. domain
controllers/Exchange
servers)

Select for integration with Windows Active Directory

Enable RADIUS
Accounting SSO clients

Select if you want to use a Remote RADIUS server.

Enable Syslog SSO Select for integration with Syslog server.

Enable FortiClient SSO
Mobility Agent Service

Once enabled, also select Enable authentication to enable SSO by
clients running FortiClient Endpoint Security.

Enter the Secret key. Be sure to use the same secret key in the
FortiClient Single Sign-On Mobility Agent settings.

5. Select OK.

Configuring the FortiGate

The FortiAuthenticator unit needs to be added to the FortiGate as an SSO agent that will provide user logon
information.

To add a FortiAuthenticator unit as SSO agent:

1. Go to User & Device > Single Sign-On and select Create New.
2. Set Type to Fortinet Single-Sign-On Agent, and enter a Name.
3. In Primary Agent IP/Name, enter the IP address of the FortiAuthenticator unit or a name.
4. In Password, enter the same secret key defined earlier on the FortiAuthenticator (under Fortinet SSO Methods

> SSO > General).
5. You may also specifyUsers/Groups from the dropdown menu.
6. Select OK.
In a few minutes, the FortiGate unit receives a list of user groups from the FortiAuthenticator unit. When you
open the server, you can see the list of groups. You can use the groups in identity-based security policies.

FSSO user groups

You can only use FortiAuthenticator SSO user groups directly in identity-based security policies. You must create
an FSSO user group, then add FortiAuthenticator SSO user groups to it. These FortiGate FSSO user groups will
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then become available for selection in identity-based security policies.

To create an FSSO user group:

1. Go to User & Device > User Groups and select Create New.
2. Enter a Name for the group.
3. Set Type to Fortinet Single Sign-On (FSSO).
4. AddMembers. The groups available to add as members are SSO groups provided by SSO agents.
5. Select OK.

Configuring the FortiClient SSO Mobility Agent

In order for the user to successfully set up the SSO Mobility Agent in FortiClient, they must know the
FortiAuthenticator IP address and pre-shared key/secret.

To configure FortiClient SSO Mobility Agent:

1. In FortiClient, go to File > Settings.
2. UnderAdvanced, select Enable Single Sign-On mobility agent.
3. In Server address, enter the IP address of the FortiAuthenticator.
4. In Customize port, enter the listening port number specified on the FortiAuthenticator unit. You can omit the

port number if it is 8005.
5. Enter the Pre-shared key.
6. Select OK.

CLI syntax

The following section contains commands to control FSSO.

user/fsso

The following command will set the server address, port, and password for multiple FSSO agents.

config user fsso
edit <name_str>

set name <string>
set [server | server2 | server3 | server4 | server5] <string>
set [port | port2 | port3 | port4 | port5] <integer>
set [password | password2 | password3 | password4 | password5] <password>

end

user/fsso-polling

The following command will set the Active Directory server port.

config user fsso-polling
edit <name_str>

set port <integer>
end
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The Optimized Fabric Transfer Protocol (OFTP) is used when information is synchronized between FortiAnalyzer
and FortiGate. Remote logging and archiving can be configured on the FortiGate to send logs to a FortiAnalyzer
(and/or FortiManager) unit.

OFTP listens on ports TCP/514 and UDP/514.

You can connect to a FortiAnalyzer unit from a FortiGate unit using Automatic Discovery, so long as both units
are on the same network. Connecting these devices in this way does not use OFTP. Instead, the Fortinet
Discovery Protocol (FDP) is used to locate the FortiAnalyzer unit.

When you select automatic discovery, the FortiGate unit uses HELLO packets to locate any FortiAnalyzer units
that are available on the network within the same subnet. When the FortiGate unit discovers the FortiAnalyzer
unit, the FortiGate unit automatically enables logging to the FortiAnalyzer unit and begins sending log data.

CLI command - To connect to FortiAnalyzer using automatic discovery:

config log fortianalyzer setting
set status [enable | disable]
set server <ip_address>
set gui-display [enable | disable]
set address-mode auto-discovery

end

If your FortiGate unit is in Transparent mode, the interface using the automatic
discovery feature will not carry traffic.

To send logs from FortiGate to FortiAnalyzer:

1. Go to Log & Report > Log Settings and enable Send Logs to FortiAnalyzer/FortiManager (underRemote
Logging and Archiving).

2. Enter the FortiAnalyzer unit's IP address in the IP Address field provided.
3. ForUpload Option, select Store & Upload Logs to set when the uploads occur (eitherDaily,Weekly, or

Monthly), and the time when the unit uploads the logs. Select Realtime to upload logs as they come across the
FortiGate unit.

4. Logs sent to FortiAnalyzer can be encrypted by enabling Encrypt Log Transmission.
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FortiClient Enterprise Management Server (FortiClient EMS) is a security management solution that enables
scalable and centralized management of multiple endpoints (computers). FortiClient EMS provides efficient and
effective administration of endpoints running FortiClient. It provides visibility across the network to securely share
information and assign security profiles to endpoints. It is designed to maximize operational efficiency and
includes automated capabilities for device management and troubleshooting.

FortiClient EMS is designed to meet the needs of small to large enterprises that deploy FortiClient on endpoints.
Benefits of deploying FortiClient EMS include:

l Remotely deploying FortiClient software to Windows PCs.
l Updating profiles for endpoint users regardless of access location, such as administering antivirus, web filtering,

VPN, and signature updates.
l Administering FortiClient endpoint registrations, such as accepting, deregistering, and blocking registrations.
l Managing endpoints, such as status, system, and signature information.
l Identifying outdated versions of FortiClient software.

Required services

You must ensure that required ports and services are enabled for use by FortiClient EMS and its associated
applications on your server. The required ports and services enable FortiClient EMS to communicate with clients
and servers running associated applications.

Communication Service Protocol Port

FortiClient endpoint registration File transfers TCP 8013 (default)

Computer browser service Enabled

Samba (SMB) service

l During FortiClient deployment, endpoints may
connect to the FortiClient EMS server using the
SMB service.

Enabled 445

Distributed Computing Environment / Remote
Procedure Calls (DCE- RPC)

l The FortiClient EMS server connects to the
endpoints using RPC for FortiClient deployment.

Enabled 135

Active Directory server connection When used as
a default
connection

389

Windows HTTP TCP 80
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Communication Service Protocol Port

Internet Information Services (IIS) HTTPS TCP 443, 10443

SQL server

For more infomation about FortiClient EMS, including other requirements, installation, and management, see
the FortiClient EMS documentation.
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FortiAP and FortiWiFi configuration guide

Welcome and thank you for selecting Fortinet products for your network protection. This document describes how
to configure wireless networks with FortiWiFi, FortiGate, and FortiAP units.

This chapter contains the following topics:

l Before you begin
l How this guide is organized

Before you begin
Before you begin using this guide, please ensure that:

l You have administrative access to the web-based manager and/or CLI.
l The FortiGate unit is integrated into your network.
l The operation mode has been configured.
l The system time, DNS settings, administrator password, and network interfaces have been configured.
l Firmware, FortiGuard Antivirus and FortiGuard Antispam updates are completed.
l FortiGuard Analysis &Management Service is properly configured.

While using the instructions in this guide, note that administrators are assumed to be super_admin administrators
unless otherwise specified. Some restrictions will apply to other administrators.

How this guide is organized
This FortiOS Handbook chapter contains the following sections:

Introduction to wireless networking explains the basic concepts of wireless networking and how to plan your
wireless network.

Configuring a WiFi LAN explains how to set up a basic wireless network, prior to deploying access point hardware.

Access point deployment explains how to deploy access point hardware and add it to your wireless network
configuration.

Wireless Mesh explains how to configure a Wi-Fi network where access points are connected to the Wi-Fi
controller wirelessly instead of by Ethernet.

Combining WiFi and wired networks with a software switch shows how to use the FortiAPWi-Fi-Ethernet bridge
feature.

Protecting the WiFi Network explains the Wireless Intrusion Detection System (WIDS).

Wireless network monitoring explains how to monitor your wireless clients and how to monitor other wireless
access points, potentially rogues, in your coverage area.
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Configuring wireless network clients explains how to configure typical wireless clients to work with a WPA-
Enterprise protected network.

Wireless network examples provides two examples. The first is a simple Wi-Fi network using automatic
configuration. The second is a more complex example of a business with two Wi-Fi networks, one for employees
and another for guests or customers.

Using a FortiWiFi unit as a client explains how to use a FortiWiFi unit as a wireless client to connect to other Wi-Fi
networks. This connection can take the place of an Ethernet connection where wired access to a network or to the
Internet is not available.

Support for location-based services explains how Fortinet supports location-based services that collect
information about devices near FortiGate-managed access points, even if the devices don’t associate with the
network.

Reference provides information about Wi-Fi radio channels.
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This chapter describes new wireless features added to FortiOS 5.6.

FortiOS 5.6.4
These features first appeared in FortiOS 5.6.4.

l "FortiAP LED Blinking" on page 1484
l "Wireless controller optimization for large deployment - AP image upgrade" on page 1484

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Hotspot 2.0

Multiple new CLI commands have been added, under config wireless-controller, to configure Hotspot
2.0 Access Network Query Protocol (ANQP), a query and response protocol that defines seamless roaming
services offered by an AP.

Syntax

config wireless-controller hotspot20 anqp-3gpp-cellular
edit {name}

config mcc-mnc-list
edit {id}

set id {integer}
set mcc {string}
set mnc {string}

next
next

end

config wireless-controller hotspot20 anqp-ip-address-type
edit {name}

set ipv6-address-type {option}
set ipv4-address-type {option}

next
end

config wireless-controller hotspot20 anqp-nai-realm
edit {name}

config nai-list
edit {name}

set encoding {enable | disable}
set nai-realm {string}
config eap-method

edit {index}
set index {integer}
set method {option}
config auth-param
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edit {index}
set index {integer}
set id {option}
set val {option}

next
next

next
next

end

config wireless-controller hotspot20 anqp-network-auth-type
edit {name}

set auth-type {option}
set url {string}

next
end

config wireless-controller hotspot20 anqp-roaming-consortium
edit {name}

config oi-list
edit {index}

set index {integer}
set oi {string}
set comment {string}

next
next

end

config wireless-controller hotspot20 anqp-venue-name
edit {name}

config value-list
edit {index}

set index {integer}
set lang {string}
set value {string}

next
next

end

config wireless-controller hotspot20 h2qp-conn-capability
edit {name}

set icmp-port {option}
set ftp-port {option}
set ssh-port {option}
set http-port {option}
set tls-port {option}
set pptp-vpn-port {option}
set voip-tcp-port {option}
set voip-udp-port {option}
set ikev2-port {option}
set ikev2-xx-port {option}
set esp-port {option}

next
end

config wireless-controller hotspot20 h2qp-operator-name
edit {name}
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config value-list
edit {index}

set index {integer}
set lang {string}
set value {string}

next
next

end

config wireless-controller hotspot20 h2qp-osu-provider
edit {name}

config friendly-name
edit {index}

set index {integer}
set lang {string}
set friendly-name {string}

next
set server-uri {string}
set osu-method {option}
set osu-nai {string}
config service-description

edit {service-id}
set service-id {integer}
set lang {string}
set service-description {string}

next
set icon {string}

next
end

config wireless-controller hotspot20 h2qp-wan-metric
edit {name}

set link-status {option}
set symmetric-wan-link {option}
set link-at-capacity {enable | disable}
set uplink-speed {integer}
set downlink-speed {integer}
set uplink-load {integer}
set downlink-load {integer}
set load-measurement-duration {integer}

next
end

config wireless-controller hotspot20 hs-profile
edit {name}

set access-network-type {option}
set access-network-internet {enable | disable}
set access-network-asra {enable | disable}
set access-network-esr {enable | disable}
set access-network-uesa {enable | disable}
set venue-group {option}
set venue-type {option}
set hessid {mac address}
set proxy-arp {enable | disable}
set l2tif {enable | disable}
set pame-bi {enable | disable}
set anqp-domain-id {integer}
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set domain-name {string}
set osu-ssid {string}
set gas-comeback-delay {integer}
set gas-fragmentation-limit {integer}
set dgaf {enable | disable}
set deauth-request-timeout {integer}
set wnm-sleep-mode {enable | disable}
set bss-transition {enable | disable}
set venue-name {string}
set roaming-consortium {string}
set nai-realm {string}
set oper-friendly-name {string}
config osu-provider

edit {name}
next

set wan-metrics {string}
set network-auth {string}
set 3gpp-plmn {string}
set conn-cap {string}
set qos-map {string}
set ip-addr-type {string}

next
end

config wireless-controller hotspot20 icon
edit {name}

config icon-list
edit {name}

set lang {string}
set file {string}
set type {option}
set width {integer}
set height {integer}

next
next

end

config wireless-controller hotspot20 qos-map
edit {name}

config dscp-except
edit {index}

set index
set dscp
set up

next
config dscp-range

edit {index}
set index
set up
set low
set high

next
next

end
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Allow admin with write permission to see plain text WiFi password (249787, 434513, 452834,
458211, 458285)

Add support for admins with write permission to read plain text password. Admins can view these plain text
passwords (captive-portal-radius-secret and passphrase) under config wireless-
controller vap. Note that security must be set as a WPA-personal setting.

WiFi Health Monitor page updates (392574, 392585, 404341, 417039, 434141, 440709)

TheWiFi Health Monitor page list of active clients now shows their MAC address entries (similar to theWiFi
Client Monitor page), making client information easier to view when opening the Active Clientwidget.

FortiAP LED Schedules (436227)

Support has been added for WTP profile LED schedules.

Use the command below (led-schedule) to assign recurring firewall schedules for illuminating LEDs on the
FortiAP. This entry is only available when led-state is enabled, at which point LEDs will be visible when at
least one of the schedules is valid.

Separate multiple schedule names with a space, as configured under config firewall schedule group
and config firewall schedule recurring.

Syntax

config wireless-controller wtp-profile
edit {name}

set led-state {enable | disable}
set led-schedules <name>

next
end

Sharing Tunnel SSIDs within a single managed AP between VDOMs as a Virtual AP for multi-
tenancy (439751)

Support has been added for the ability to move a tunnel mode VAP into a VDOM, similar to an interface/VLAN in
VDOMs.

FortiAP is registered into the root VDOM. Within a customer VDOM, customer VAPs can be created/added. In the
root VDOM, the customer VAP can be added to the registered FortiAP. Any necessary firewall rules and
interfaces can be configured between the two VDOMs.

Syntax

config wireless-controller global
set wtp-share {enable | disable}

end

30D/30E models support two normal-mode FAPs (446122)

Fixed an issue that blocked FortiGate 30D and 30Emodels from supporting two normal-mode FortiAPs.
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MAC Bypass for Captive Portal (448296)

Support has been added to provide a MAC address bypass for authenticated clients. Previously, when clients
were authenticated with bridged SSID and their MAC addresses were known, they were not redirected to the
External Captive Portal.

A new portal type has been added, under config wireless-controller vap, to provide successful MAC
authentication Captive Portal functionality.

Syntax

config wireless-controller vap
edit {name}

set portal-type {cmcc-macauth}
next

end

WiFi Health Monitor fixes (449341)

An issue has been addressed where the Client Countwidget (underWiFi Health Monitor) showed wrong
options for the timeline selection.

The fixes include:

l Fixed timeline selection options to correct values.
l Updated time filter parameters with correct arguments in the Login Failureswidget.
l Added local radio to AP Statuswidget details.
l Fixed Login Failureswidget, where the SSID name was improperly formatted if it contained HTML characters.

Various bug fixes (452975, 455218, 453161, 405117, 453533, 453535, 184384)

Various fixes have been implemented to address a variety of issues:

The fixes include:

l Removed code to avoid repeated printing "parse dhcp options" after upgrade or reboot.
l Removed code that supported FAP-C221E, C226E, and C21D, as their product names changed.
l Changed the text for incorrect WiFi CLI help descriptions.
l Fixed background scan settings for FAP 222C, 223C, 321C, C220C, C225C, C23JD, and C24JE.
l Set WTP entry with "discovered" state to built-in in order to skip them, as only managed FAPs can be counted

toward FAP capacity.

Configure how a FortiWiFi WiFi interface in client mode selects a WiFi band (455305)

For an FortiWiFi WiFi interface operating in client mode, you can use the following option to configure the WiFi
band that the interface can connect to. You can configure the interface to connect to any band, just to the 5G
band or to prefer connecting to the 5G band.

Syntax

config system interface
edit {name}

set wifi-ap-band {any | 5g-preferred | 5g-only}
next

end
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FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

Support for various FortiAP models (416177) (435638) (424483)

FortiAP units FAP-U321EV, FAP-U323EV, FAP-S221E, FAP-S223E, FAP-222E, FAP-221E, and FAP-223E are
supported by FortiOS 5.6.1.

As part of this support, new CLI attributes have been added under config wireless-controller wtp-
profile to manage their profiles.

CLI syntax

config wireless-controller wtp-profile
edit <model>

config platform
set type <model>

end
set ap-country <code>
config radio-1

set band 802.11n
end
config radio-2

set band 802.11ac
end

next
end

New Managed AP Groups and Dynamic VLAN Assignment (436267)

The FortiGate can create FortiAPGroups, underWiFi & Switch Controller > Managed Devices > Managed
FortiAPs by selecting Create New > Managed AP Group, where multiple APs can be managed. AP grouping
allows specific profile settings to be applied to many APs all at once that belong to a certain AP group, simplifying
the administrative workload.

Note that each AP can only belong to one group.

In addition, VLANs can be assigned dynamically based on the group which an AP belongs. When defining an
SSID, underWiFi & Switch Controller > SSID, a setting called VLAN Pooling can be enabled where you
can either assign the VLAN ID of the AP group the device is connected to, to each device as it is detected, or to
always assign the same VLAN ID to a specific device. Dynamic VLAN assignment allows the same SSID to be
deployed to many APs, avoiding the need to produce multiple SSIDs.

GUI support for configuring multiple pre-shared keys for SSID interfaces (406321)

Multiple pre-shared keys can be created per SSID. When creating a new SSID, enableMultiple Pre-shared
Keys underWiFi Settings.

FortiAP Bluetooth Low Energy (BLE) Scan (438274)

The FortiGate can configure FortiAP Bluetooth Low Energy (BLE) scan, incorporating Google's BLE beacon
profile known as Eddystone, used to identify groups of devices and individual devices.
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Currently, only the FAP-S221E, FAP-S223E, and FAP-222Emodels support this
feature.

As part of this support, new CLI attributes have been added under config wireless-controller
timers and config wireless-controller wtp-profile, including a new CLI command, config
wireless-controller ble-profile.

CLI syntax - Configure BLE profiles

config wireless-controller ble-profile
edit <name>

set comment <comment>
set advertising {ibeacon | eddystone-uid | eddystone-url}
set ibeacon-uuid <uuid>
set major-id <0 - 65535> - (default = 1000)
set minor-id <0 - 65535> - (default = 1000)
set eddystone-namespace <10-byte namespace>
set eddystone-instance <device id>
set eddystone-url <url>
set txpower <0 - 12> - (default = 0)
set beacon-interval <40 - 3500> - (default = 100)
set ble-scanning {enable | disable} - (default = disable)

next
end

Note that txpower determines the transmit power level on a scale of 0-12:

0: -21 dBm 1: -18 dBm 2: -15 dBm 3: -12 dBm 4: -9 dBm

5: -6 dBm 6: -3 dBm 7: 0 dBm 8: 1 dBm 9: 2 dBm

10: 3 dBm 11: 4 dBm 12: 5 dBm

CLI syntax - Configure BLE report intervals

config wireless-controller timers
set ble-scan-report-intv - (default = 30 sec)

end

CLI syntax - Assign BLE profiles to WTP profiles

config wireless-controller wtp-profile
edit <name>

set ble-profile <name>
next

end

WiFi client monitor page search enhanced (440709)

WiFi Cient Monitor page (Monitor > WiFi Client Monitor) now supports search function.
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FortiOS 5.6.0
These features first appeared in FortiOS 5.6.0.

Captive Portal Authentication with FortiAP in Bridge Mode (408915)

The FortiGate can operate as a web captive portal server to serve the captive portal local bridge mode.

A new CLI command has been added under config wireless-controller vap to set the captive portal
type to CMCC, a wireless cipher.

CLI syntax

config wireless-controller vap
edit <name>

set portal-type { ... | cmcc}
next

end

802.11kv(r) support (405498, 395037)

New CLI commands have been added under config wireless-controller vap to set various 802.11kvr
settings, or Voice Enterprise (802.11kv) and Fast Basic Service Set (BSS) Transition (802.11r), to provide faster
and more intelligent roaming for the client.

CLI syntax

config wireless-controller vap
edit <name>

set voice-enterprise {enable | disable}
set fast-bss-transition {enable | disable}
set ft-mobility-domain
set ft-r0-key-lifetime [1-65535]
set ft-over-ds {enable | disable}

next
end

External Captive Portal authentication with FortiAP in Bridge Mode (403115, 384872)

New CLI commands have been added under config wireless-controller vap to set various options
for external captive portal with FortiAP in Bridge Mode. The commands set the standalone captive portal server
category, the server's domain name or IP address, secret key to access the RADIUS server, and the standalone
captive portal Access Controller (AC) name.

Note that these commands are only available when local-standalone is set to enable and security is set to
captive-portal.

CLI syntax

config wireless-controller vap
edit <name>

set captive-portal-category {FortiCloud | CMCC} Default is FortiCloud.
set captive-portal-radius-server <server>
set captive-portal-radius-secret <password>
set captive-portal-ac-name <name>
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next
end

Japan DFS support for FAP-421E/423E/S421E/S423E (402287, 401434)

Korea and Japan Dynamic Frequency Selection (DFS) certification has been added for FAP-
421E/423E/S421E/S423E. DFS is a mechanism that allowsWLANs to select a frequency that does not interfere
with certain radar systems while operating in the 5 GHz band.

802.3az support on WAVE2 WiFi APs (400558)

A new CLI command has been added under config wireless-controller wtp-profile to enable or
disable use of Energy-Efficient Ethernet (EEE) on WTP, allowing for less power consumption during periods of
low data activity.

CLI syntax

config wireless-controller wtp-profile
edit <profile-name>

set energy-efficient-ethernet {enable|disable}
end

CLI command update made in wids-profile (400263)

The CLI command rogue-scan under config wireless-controller wids-profile has been
changed to sensor-mode and allows easier configuration of radio sensor mode. Note that while foreign
enables radio sensor mode on foreign channels only, both enables the feature on foreign and home channels.

CLI syntax

config wireless-controller wids-profile
edit <example>

set sensor-mode {disable|foreign|both}
end

Channel utilization, FortiPresence support on AP mode, QoS enhancement for voice (399134,
377562)

A new CLI command has been added, config wireless-controller qos-profile, to configure
quality of service (QoS) profiles where you can add WiFi multi-media (WMM) control and Differentiated Services
Code Point (DSCP) mapping.

Note that:

l call-capacity and bandwidth-admission-control are only available when call-admission-
control is set to enable.

l bandwidth-capacity is only available when bandwidth-admission-control is set to enable.
l All DSCPmapping options are only available when dscp-wmm-mapping is set to enable.
l wmm is already set to enable by default. If wmm is set to disable, the following entries are not available: wmm-
uapsd, call-admission-control, and dscp-wmm-mapping.

CLI syntax

config wireless-controller qos-profile
edit <example>
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set comment <comment>
set uplink [0-2097152] Default is 0 Kbps.
set downlink [0-2097152] Default is 0 Kbps.
set uplink-sta [0-2097152] Default is 0 Kbps.
set downlink-sta [0-2097152] Default is 0 Kbps.
set burst {enable|disable} Default is disable.
set wmm {enable|disable} Default is enable.
set wmm-uapsd {enable|disable} Default is enable.
set call-admission-control {enable|disable} Default is disable.
set call-capacity [0-60] Default is 10 phones.
set bandwidth-admission-control {enable|disable} Default is disable.
set bandwidth-capacity [1-600000] Default is 2000 Kbps.
set dscp-wmm-mapping {enable|disable} Default is disable.
set dscp-wmm-vo [0-63] Default is 48 56.
set dscp-wmm-vi [0-63] Default is 32 40.
set dscp-wmm-be [0-63] Default is 0 24.
set dscp-wmm-bk [0-63] Default is 8 16.

QoS profiles can be assigned under the config wireless-controller vap command using qos-
profile.

FortiCloud managed APs can now be applied a bandwidth restriction or rate limitation based on SSID. For
instance if guest and employee SSIDs are available, you can rate limit guest access to a certain rate to
accommodate for employees. This feature also applies a rate limit based on the application in use, as APs are
application aware.

FAP-U421E and FAP-U423E support (397900)

Two Universal FortiAPmodels support FortiOS 5.6. Their default profiles are added under config wireless-
controller wtp-profiles, as shown below:

CLI syntax

config wireless-controller wtp-profile
edit "FAPU421E-default"

config platform
set type U421E

end
set ap-country US
config radio-1

set band 802.11n
end
config radio-2

set band 802.11ac
end

next
end

config wireless-controller wtp-profile
edit "FAPU423E-default"

config platform
set type U423E

end
set ap-country US
config radio-1

set band 802.11n
end
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config radio-2
set band 802.11ac

end
next

end

Minor reorganization of WiFi GUI entries (396497)

WiFi & Switch ControllerGUI entriesManaged FortiAPs, SSID, FortiAP Profiles, andWIDS Profiles
have been reorganized.

Multiple PSK support for WPA personal (393320, 264744)

New CLI commands have been added, under config wireless-controller vap, to configure multiple
WiFi Protected Access Pre-Shared Keys (WPA-PSKs), as PSK is more secure without all devices having to share
the same PSK.

Note that, for the following multiple PSK related commands to become available, vdom, ssid, and
passhphrase all have to be set first.

CLI syntax

config wireless-controller vap
edit <example>

set mpsk {enable|disable}
set mpsk-concurrent-clients [0-65535] Default is 0.
config mpsk-key

edit key-name <example>
set passphrase <wpa-psk>
set concurrent-clients [0-65535] Default is empty.
set comment <comments>

next
end

end

Use the mpsk-concurrent-clients entry to set the maximum number of concurrent connected clients for
each mpsk entry. Use the mpsk-key configuration method to configure multiple mpsk entries.

Table size of qos-profile has VDOM limit (388070)

The command config wireless-controller qos-profile now has VDOM table limit; there is no
longer an unlimited number of entries within each VDOM.

Add "dhcp-lease-time" setting to local-standalone-nat VAP (384229)

When a Virtual Access Point (VAP) has been configured for a FortiAP, a DHCP server is automatically configured
on the FortiAP side with a hard lease time. A new CLI command under config wireless-controller
vap has been added to customize the DHCP lease time for NAT IP address. This is to solve issues where the
DHCP IP pool was exhausted when the number of clients grew too large for the lease time span.

Note that the new command, dhcp-lease-time, is only available when local-standalone is set to
enable, then setting local-standalone-nat to enable.

CLI syntax

config wireless-controller vap
edit <example>
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set local-standalone {enable|disable}
set local-standalone-nat {enable|disable}
set dhcp-lease-time [300-8640000] Default is 2400 seconds.

end

New CLI command to configure LDPC for FortiAP (383864)

Previously, LDPC value on FortiAP could only be changed on FortiAP local CLI. Syntax has been added in
FortiOS CLI under the 'wireless-controller.vap' entry to configure the LDPC value on FortiAP.

CLI Syntax

configure wireless-controller vap
edit 1

set ldpc [enable|rx|tx|disable]
end

New region code/SKU for Indonesia (382926)

A new country region code, F, has been added to meet Indonesia's WiFi channel requirements. Indonesia
previously belonged to region code W.

FortiAP RMA support added (381936)

New CLI command fortiap added under exe replace-device to replace an old FortiAP's serial number
with a new one.

CLI Syntax

execute replace-device fortiap <old-fortiap-id> <new-fortiap-id>

Support fixed-length 64-hex digit for WPA-Personal passphrase (381030)

WPA-Personal passphrase now supports a fixed-length of 64 hexadecimal digits.

Allow FortiGates to manage cloud-based FortiAPs (380150)

FortiGates can now manage cloud-based FortiAPs using the new fapc-compatibility command under
wireless-controller setting.

If enabled, default FAP-C wtp-profiles will be added. If disabled, FAP-C related CMDB configurations will be
removed: wtp-group in vap's vlan-pool, wtp-group, ws, wtp, wtp-profile.

CLI syntax

config wireless-controller setting
set country CN
set fapc-compatibility [enable|disable]

end

You will receive an error message when trying to change country while fapc-
compatibility is enabled. You need to disable fapc-compatibility before
changing to an FAPC unsupported country.
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Use IPsec instead of DTLS to protect CAPWAP tunnels (379502)

This feature is to utilize FortiAP hardware to improve the throughput of tunneled data traffic by using IPsec when
data security is enabled.

"AES-256-CBC & SHA256" algorithm and "dh_group 15" are used for both CAPWAP IPsec phase1 and phase 2.

FAP320B will not support this feature due to its limited capacity of free flash.

New option added to support only one IP per one endpoint association (378207)

When users change configuration, the radiusd will reset all configurations and refresh all logons in the kernel. All
these actions are done in the one loop. A CLI option has been added to enable/disable replacement of an old IP
address with a new IP address for the same endpoint on RADIUS accounting start.

CLI Syntax

configure user radius
edit radius-root

set rsso-ep-one-ip-only [enable|disable]
next

end

FAP-222C-K DFS support (377795)

Dynamic Frequency Selection (DFS) bands can now be configured for FortiAP 222C-K.

Note that this FortiAPmodel has the Korean region code (K), but ap-country under config wireless-
controller wtp-profile still needs to be set to KR.

CLI syntax

config wireless-controller wtp-profile
edit <K-FAP222C>

config platform
set type <222C>

end
set ap-country KR
config radio-2

set band <802.11ac>
set vap-all <disable>
set vaps "vap-vd-07"
set channel "52" "56" "60" "64" "100" "104" "108" "112" "116" "120" "124" "128"

"132" "136" "140"
end

next
end

Dynamic VLAN support in standalone mode (377298)

Dynamic VLAN is now supported in standalone mode. Previously, dynamic VLAN only worked in local bridge
mode.
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CLI-only features added to GUI (376891)

Previously CLI-only features have been added to the GUI under FortiAP Profiles, Managed FortiAPs, and
SSID. Also fixed issue where the correct value is displayed when viewing theWIDS Profile notification icon
under FortiAP Profiles.

Managed AP GUI update (375376)

Upgraded Managed FortiAPs dialog page to a newer style, including icons for SSID and LAN port.

Bonjour gateway support (373659)

Bonjour gateway now supported for WiFi networks.

Syntax
config wireless-controller bonjour-profile

edit 0
set comment "comment"
config policy-list

edit 1
set description "description"
set from-vlan [0-4094] Default is 0.
set to-vlan [0-4094|all] Default is all.
set services [all|airplay|afp|bit-

torrent|ftp|ichat|itunes|printers|samba|scanners|ssh|chromecast]
next

end
next

end

FAP421E/423E wave2 support (371374)

Previously removed wave2 FAP421E and FAP423Emodels have been reinstated and are now supported again.
The models are available again through the CLI and GUI. These models are listed under the Platform dropdown
menu when creating a new FortiAP Profile underWiFi & Switch Controller > FortiAP Profiles.

CLI syntax

config wireless-controller wtp-profile
edit <example>
config platform

set type <...|421E|423E>
end

end

WiFi Health Monitor GUI changes (308317)

The Wifi Health Monitor page has been improved, including the following changes:

l Flowchart used for diagrams
l Chart used for interference and AP clients
l Removed spectrum analysis
l Added functionality to upgrade FortiAP firmware
l Added option to view both 2.4GHz and 5GHz data simultaneously
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AP Profile GUI page updates (298266)

The AP Profile GUI page has been upgraded to a new style including AngularJS code.

1+1 Wireless Controller HA (294656)

Instances of failover between FortiAP units was too long and lead to extended periods of time where WiFi users
were without network connection. Because WiFi is considered a primary network connection in today's verticals
(including enterprise, retail, education, warehousing, healthcare, government, and more), it is necessary for
successful failover to occur as fast as possible.

You can now define the role of the primary and secondary controllers on the FortiAP unit, allowing the unit to
decide the order in which the FortiAP selects the FortiGate. This process was previously decided on load-based
detection, but can now be defined by each unit's pre-determined priority. In addition, heartbeat intervals have
been lowered to further improve FortiAP awareness and successful failover.

Syntax

config wireless-controller inter-controller
set inter-controller-mode {disable | l2-roaming | 1+1} Default is disable.
set inter-controller-key <password>
set inter-controller-pri {primary | secondary} Default is primary.
set fast-failover-max [3-64] Default is 10.
set fast-failover-wait [10-86400] Default is 10.
config inter-controller-peer

edit <name>
set peer-ip <ip-address>
set peer-port [1024-49150] Default is 5246.
set peer-priority {primary | secondary} Default is primary.

next
end

end

Support for duplicate SSID names on tunnel and bridge mode interfaces (278955)

When duplicate-ssid is enabled in the CLI, this feature allows VAPs to use the same SSID name in the
same VDOM. When disabled, all SSIDs in WLAN interface will be checked—if duplicate SSIDs exist, an error
message will be displayed. When duplicate-ssid is enabled in the CLI, duplicate SSID check is removed in
"Edit SSID" GUI page.

Syntax

config wireless-controller setting
set duplicate-ssid [enable|disable]
next

end

Controlled failover between wireless controllers (249515)

Instances of failover between FortiAP units was too long and lead to extended periods of time where WiFi users
were without network connection. Because WiFi is considered a primary network connection in today's verticals
(including enterprise, retail, education, warehousing, healthcare, government, and more), it is necessary for
successful failover to occur as fast as possible.
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Administrators can now define the role of the primary and secondary controllers on the FortiAP unit, allowing the
unit to decide the order in which the FortiAP selects the FortiGate. This process was decided on load-based
detection, but can now be defined by each unit's pre-determined priority. In addition, heartbeat intervals have
been lowered to further improve FortiAP awareness and successful failover.
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This chapter introduces some concepts you should understand before working with wireless networks, describes
Fortinet’s wireless equipment, and then describes the factors you need to consider in planning deployment of a
wireless network.

Wireless concepts
Wireless networking is radio technology, subject to the same characteristics and limitations as the familiar audio
and video radio communications. Various techniques are used to modulate the radio signal with a data stream.

Bands and channels

Depending on the wireless protocol selected, you have specific channels available to you, depending on what
region of the world you are in.

l IEEE 802.11b and g protocols provide up to 14 channels in the 2.400-2.500 GHz Industrial, Scientific and Medical
(ISM) band.

l IEEE 802.11a,n (5.150-5.250, 5.250-5.350, 5.725–5.875 GHz, up to 16 channels) in portions of Unlicensed
National Information Infrastructure (U-NII) band

Note that the width of these channels exceeds the spacing between the channels. This means that there is some
overlap, creating the possibility of interference from adjacent channels, although less severe than interference on
the same channel. Truly non-overlapping operation requires the use of every fourth or fifth channel, for example
ISM channels 1, 6 and 11.

The capabilities of your wireless clients is the deciding factor in your choice of wireless protocol. If your clients
support it, 5GHz protocols have some advantages. The 5GHz band is less used than 2.4GHz and its shorter
wavelengths have a shorter range and penetrate obstacles less. All of these factors mean less interference from
other access points, including your own.

When configuring your WAP, be sure to correctly select the Geography setting to ensure that you have access
only to the channels permitted for WiFi use in your part of the world.

For detailed information about the channel assignments for wireless networks for each supported wireless
protocol, see Reference on page 1555.

Power

Wireless LANs operate on frequencies that require no license but are limited by regulations to low power. As with
other unlicensed radio operations, the regulations provide no protection against interference from other users
who are in compliance with the regulations.

Power is often quoted in dBm. This is the power level in decibels compared to one milliwatt. 0dBm is one
milliwatt, 10dBm is 10 milliwatts, 27dBm, the maximum power on Fortinet FortiAP equipment, is 500 milliwatts.
The FortiGate unit limits the actual power available to the maximum permitted in your region as selected by the
WiFi controller country setting.
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Received signal strength is almost always quoted in dBm because the received power is very small. The numbers
are negative because they are less than the one milliwatt reference. A received signal strength of -60dBm is one
millionth of a milliwatt or one nanowatt.

Antennas

Transmitted signal strength is a function of transmitter power and antenna gain. Directional antennas
concentrate the signal in one direction, providing a stronger signal in that direction than would an omnidirectional
antenna.

FortiWiFi units have detachable antennas. However, these units receive regulatory approvals based on the
supplied antenna. Changing the antenna might cause your unit to violate radio regulations.

Security
There are several security issues to consider when setting up a wireless network.

Whether to broadcast SSID

It is highly recommended to broadcast the SSID. This makes connection to a wireless network easier because
most wireless client applications present the user with a list of network SSIDs currently being received. This is
desirable for a public network.

Attempting to obscure the presence of a wireless network by not broadcasting the SSID does not improve network
security. The network is still detectable with wireless network “sniffer” software. Clients search for SSIDs that they
know, leaking the SSID. Refer to RFC 3370. Also, many of the latest Broadcom drivers do not support hidden
SSID for WPA2.

Encryption

Wireless networking supports the following security modes for protecting wireless communication, listed in order
of increasing security.

None—Open system. Any wireless user can connect to the wireless network.

WEP64— 64-bit Web Equivalent Privacy (WEP). This encryption requires a key containing 10 hexadecimal digits.

WEP128— 128-bit WEP. This encryption requires a key containing 26 hexadecimal digits.

WPA— 256-bit WiFi Protected Access (WPA) security. This encryption can use either the TKIP or AES encryption
algorithm and requires a key of either 64 hexadecimal digits or a text phrase of 8 to 63 characters. It is also
possible to use a RADIUS server to store a separate key for each user.

WPA2—WPAwith security improvements fully meeting the requirements of the IEEE 802.11i standard.
Configuration requirements are the same as for WPA.

For best security use the WPA2 with AES encryption and a RADIUS server to verify individual credentials for each
user. WEP, while better than no security at all, is an older algorithm that is easily compromised. With either WEP
or WAP, changing encryption passphrases on a regular basis further enhances security.

Separate access for employees and guests

Wireless access for guests or customers should be separate from wireless access for your employees. This does
not require additional hardware. Both FortiWiFi units and FortiAP units support multiple wireless LANs on the
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same access point. Each of the two networks can have its own SSID, security settings, firewall policies, and user
authentication.

Two separate wireless networks are possible because multiple virtual APs can be associated with an AP profile.
The same physical APs can provide two or more virtual WLANs.

Captive portal

As part of authenticating your users, you might want them to view a web page containing your acceptable use
policy or other information. This is called a captive portal. No matter what URL the user initially requested, the
portal page is returned. Only after authenticating and agreeing to usage terms can the user access other web
resources.

For more information about captive portals, see the Captive portals chapter of the FortiOS Authentication Guide.

Power

Reducing power reduces unwanted coverage and potential interference to other WLANs. Areas of unwanted
coverage are a potential security risk. There are people who look for wireless networks and attempt to access
them. If your office WLAN is receivable out on the public street, you have created an opportunity for this sort of
activity.

Monitoring for rogue APs

It is likely that there are APs available in your location that are not part of your network. Most of these APs belong
to neighboring businesses or homes. They may cause some interference, but they are not a security threat. There
is a risk that people in your organization could connect unsecured WiFi-equipped devices to your wired network,
inadvertently providing access to unauthorized parties. The optional On-Wire Rogue APDetection Technique
compares MAC addresses in the traffic of suspected rogues with the MAC addresses on your network. If wireless
traffic to non-Fortinet APs is also seen on the wired network, the AP is a rogue, not an unrelated AP.

Decisions about which APs are rogues are made manually on the Rogue APmonitor page. For detailed
information, see Wireless network monitoring on page 1489.

Suppressing rogue APs

When you have declared an AP to be a rogue, you have the option of suppressing it. To suppress and AP, the
FortiGate WiFi controller sends reset packets to the rogue AP. Also, the MAC address of the rogue AP is blocked
in the firewall policy. You select the suppression action on the Rogue APmonitor page. For more information, see
Wireless network monitoring on page 1489.

Rogue suppression is available only when there is a radio dedicated to scanning. It will
not function during background scanning for spectrum analysis.

Wireless Intrusion Detection (WIDS)

You can create a WIDS profile to enable several types of intrusion detection:

l Unauthorized Device Detection
l Rogue/Interfering AP Detection
l Ad-hoc Network Detection and Containment

1399 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Introduction to wireless networking

l Wireless Bridge Detection
l Misconfigured APDetection
l WeakWEPDetection
l Multi Tenancy Protection
l MACOUI Checking

For more information, see Protecting the WiFi Network on page 1485.

Authentication
Wireless networks usually require authenticated access. FortiOS authentication methods apply to wireless
networks the same as they do to wired networks because authentication is applied in the firewall policy.

The types of authentication that you might consider include:

l user accounts stored on the FortiGate unit
l user accounts managed and verified on an external RADIUS, LDAP or TACACS+ server
l Windows Active Directory authentication, in which users logged on to a Windows network are transparently

authenticated to use the wireless network.

This Wireless chapter of the FortiOS Handbook will provide some information about each type of authentication,
but more detailed information is available in the Authentication chapter.

What all of these types of authentication have in common is the use of user groups to specify who is authorized.
For each wireless LAN, you will create a user group and add to it the users who can use the WLAN. In the identity-
based firewall policies that you create for your wireless LAN, you will specify this user group.

Some access points, including FortiWiFi units, support MAC address filtering. You should not rely on this alone
for authentication. MAC addresses can be “sniffed” from wireless traffic and used to impersonate legitimate
clients.

Wireless networking equipment
Fortinet produces two types of wireless networking equipment:

l FortiWiFi units, which are FortiGate units with a built-in wireless access point/client
l FortiAP units, which are wireless access points that you can control from any FortiGate unit that supports the WiFi

Controller feature.

FortiWiFi units

A FortiWiFi unit can:

l Provide an access point for clients with wireless network cards. This is called Access Point mode, which is the
default mode.

or

l Connect the FortiWiFi unit to another wireless network. This is called Client mode. A FortiWiFi unit operating in
client mode can only have one wireless interface.

or

l Monitor access points within radio range. This is called Monitoring mode. You can designate the detected access
points as Accepted or Rogue for tracking purposes. No access point or client operation is possible in this mode. But,
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you can enable monitoring as a background activity while the unit is in Access Point mode.

The Products section of the Fortinet web site (www.fortinet.com) provides detailed information about the
FortiWiFi models that are currently available.

FortiAP units

FortiAP units are thin wireless access points are controlled by either a FortiGate unit or FortiCloud service.

FortiAP is a family of Indoor, Outdoor and Remote Access Point models supporting the latest single, dual, and
triple stream MIMO 802.11ac and 802.11n technology, as well as 802.11g and 802.11a.

For large deployments, some FortiAPmodels support a mesh mode of operation in which control and data
backhaul traffic between APs and the controller are carried on a dedicated WiFi network. Users can roam
seamlessly from one AP to another.

In dual-radio models, each radio can function as an AP or as a dedicated monitor. The monitoring function is also
available during AP operation, subject to traffic levels.

The Products section of the Fortinet web site (www.fortinet.com) provides detailed information about the FortiAP
models that are currently available.

Automatic Radio Resource Provisioning
To prevent interference between APs, the FortiOSWiFi Controller includes the Distributed Automatic Radio
Resource Provisioning (DARRP) feature. Through DARRP, each FortiAP unit autonomously and periodically
determines the channel that is best suited for wireless communications. FortiAP units to select their channel so
that they do not interfere with each other in large-scale deployments where multiple access points have
overlapping radio ranges.

To enable ARRP - GUI

1. Go toWiFi Controller > FortiAP Profiles and edit the profile for your device.
2. In the Radio sections (Radio 1, Radio 2, etc.), enable Radio Resource Provision.
3. ClickOK.

To enable ARRP - CLI

In this example, ARRP is enabled for both radios in the FAP321C-default profile:

config wireless-controller wtp-profile
edit FAP321C-default

config radio-1
set darrp enable

end
config radio-2

set darrp enable
end

end

Setting ARRP timing

By default, ARRP optimization occurs at a fixed interval of 1800 seconds (30 minutes). You can change this
interval in the CLI. For example, to change the interval to 3600 seconds enter:
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config wireless-controller timers
set darrp-optimize 3600

end

Optionally, you can schedule optimization for fixed times. This enables you to confine ARRP activity to a low-
traffic period. Setting darrp-optimize to 0, makes darrp-day and darrp-time available. For example,
here's how to set DARRP optimization for 3:00am every day:

config wireless-controller timers
set darrp-optimize 0
set darrp-day sunday monday tuesday wednesday thursday friday saturday
set darrp-time 03:00

end

Both darrp-day and darrp-time can accept multiple entries.
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A captive portal is a convenient way to authenticate web users on wired or WiFi networks.

This section describes:

l Introduction to Captive portals
l Configuring a captive portal
l Customizing captive portal pages
l Configuration example - Captive portal WiFi access control

Introduction to Captive portals
You can authenticate your users on a web page that requests the user’s name and password. Until the user
authenticates successfully, the authentication page is returned in response to any HTTP request. This is called a
captive portal.

After successful authentication, the user accesses the requested URL and can access other web resources, as
permitted by security policies. Optionally, the captive portal itself can allow web access to only the members of
specified user group.

The captive portal can be hosted on the FortiGate unit or on an external authentication server. You can configure
captive portal authentication on any network interface, including WiFi and VLAN interfaces.

When a captive portal is configured on a WiFi interface, the access point initially appears open. The wireless
client can connect to the access point with no security credentials, but sees only the captive portal authentication
page.

WiFi captive portal types:

l Authentication— until the user enters valid credentials, no communication beyond the AP is permitted.
l Disclaimer + Authentication— immediately after successful authentication, the portal presents the disclaimer

page—an acceptable use policy or other legal statement—to which the user must agree before proceeding.
l Disclaimer Only— the portal presents the disclaimer page—an acceptable use policy or other legal statement—

to which the user must agree before proceeding. The authentication page is not presented.
l Email Collection — the portal presents a page requesting the user’s email address, for the purpose of contacting

the person in future. This is often used by businesses who provide free WiFi access to their customers. The
authentication page is not presented.

l MAC Bypass— when clients are authenticated against their bridged SSID and their MAC addresses are known,
they are redirected to the external captive portal.

Configuring a captive portal
Captive portals are configured on network interfaces. AWiFi interface does not exist until the WiFi SSID is
created. You can configure a WiFi captive portal at the time that you create the SSID. Afterwards, the captive
portal settings will also be available by editing the WiFi network interface in System > Network > Interfaces.
On a physical (wired) network interface, you edit the interface configuration in System > Network > Interfaces
and set Security Mode to Captive Portal.
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To configure a WiFi Captive Portal - web-based manager:

1. Go toWiFi Controller > WiFi Network > SSID and create your SSID.
If the SSID already exists, you can edit the SSID or you can edit the WiFi interface in System > Network >
Interfaces.

2. In Security Mode, select Captive Portal.

3. Enter

Portal Type The portal can provide authentication and/or disclaimer, or perform user
email address collection. See Introduction to Captive portals on page 1403.

Authentication Portal Local - portal hosted on the FortiGate unit.

Remote - enter FQDN or IP address of external portal.

User Groups Select permitted user groups.

Exempt List Select exempt lists whose members will not be subject to captive portal
authentication.

Customize Portal Messages Click the link of the portal page that you want to modify. See "Captive
portals" on page 1405.

4. Select OK.

To configure a wired Captive Portal - web-based manager:

1. Go to System > Network > Interfaces and edit the interface to which the users connect.
2. In Security Mode select Captive Portal.

3. Enter
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Authentication Portal Local - portal hosted on the FortiGate unit.

Remote - enter FQDN or IP address of external portal.

User Groups Select permitted user groups or select Use Groups from Policies, which
permits the groups specified in the security policy.

Use Groups from Policies is not available in WiFi captive portals.

Exempt List Select exempt lists whose members will not be subject to captive portal
authentication.

Customize Portal
Messages

Enable, then select Edit. See Customizing captive portal pages on page
1405.

4. Select OK.

Exemption from the captive portal

A captive portal requires all users on the interface to authenticate. But some devices are not able to authenticate.
You can create an exemption list of these devices. For example, a printer might need to access the Internet for
firmware upgrades. Using the CLI, you can create an exemption list to exempt all printers from authentication.

config user security-exempt-list
edit r_exempt

config rule
edit 1

set devices printer
end

end

MAC Bypass for Captive Portal

It is possible to provide a MAC address bypass for authenticated clients.When clients are authenticated with
bridged SSID and their MAC addresses are known, they are redirected to the External Captive Portal.

A new portal type has been added, under config wireless-controller vap, to provide successful MAC
authentication Captive Portal functionality.

Syntax

config wireless-controller vap
edit {name}

set portal-type {cmcc-macauth}
next

end

Customizing captive portal pages
These pages are defined in replacement messages. Defaults are provided. In the web-based manager, you can
modify the default messages in the SSID configuration by selecting Customize Portal Messages. Each SSID
can have its own unique portal content.

The captive portal contains the following default web pages:
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l Login page—requests user credentials

Typical modifications for this page would be to change the logo and modify some of the text.

You can change any text that is not part of the HTML code nor a special tag enclosed in double percent (%)
characters.

There is an exception to this rule. The line “Please enter your credentials to continue” is provided by the
%%QUESTION%% tag. You can replace this tag with text of your choice. Except for this item, you should not
remove any tags because they may carry information that the FortiGate unit needs.

l Login failed page—reports that the entered credentials were incorrect and enables the user to try again.
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The Login failed page is similar to the Login page. It even contains the same login form. You can change any text
that is not part of the HTML code nor a special tag enclosed in double percent (%) characters.

There is an exception to this rule. The line “Firewall authentication failed. Please try again.” is provided by the
%%FAILED_MESSAGE%% tag. You can replace this tag with text of your choice. Except for this item, you should
not remove any tags because they may carry information that the FortiGate unit needs.

l Disclaimer page—is a statement of the legal responsibilities of the user and the host organization to which the
user must agree before proceeding.(WiFi or SSL VPN only)
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l Declined disclaimer page—is displayed if the user does not agree to the statement on the Disclaimer page.
Access is denied until the user agrees to the disclaimer.
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Changing images in portal messages

You can replace the default Fortinet logo with your organization’s logo. First, import the logo file into the
FortiGate unit and then modify the Login page code to reference your file.

To import a logo file:

1. Go to System > Config > Replacement Messages and select Manage Images.
2. Select Create New.
3. Enter a Name for the logo and select the appropriate Content Type.

The file must not exceed 24 Kilo bytes.
4. Select Browse, find your logo file and then select Open.
5. Select OK.

To specify the new logo in the replacement message:

1. Go to System > Network > Interfaces and edit the interface.
The Security Modemust be Captive Portal.

2. Select the portal message to edit.
l In SSL VPN or WiFi interfaces, in Customize Portal Messages click the link to the portal messages that you

want to edit.
l In other interfaces, make sure that Customize Portal Messages is selected, select the adjacent Edit icon,

then select the message that you want to edit.

3. In the HTML message text, find the %%IMAGE tag.
By default it specifies the Fortinet logo: %%IMAGE:logo_fw_auth%%

4. Change the image name to the one you provided for your logo.
The tag should now read, for example, %%IMAGE:mylogo%%

5. Select Save.
6. Select OK.
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Modifying text in portal messages

Generally, you can change any text that is not part of the HTML code nor a special tag enclosed in double percent
(%) characters. You should not remove any tags because they may carry information that the FortiGate unit
needs. See the preceding section for any exceptions to this rule for particular pages.

To modify portal page text

1. Go to System > Network > Interfaces and edit the interface.
The SSID Security Modemust be Captive Portal.

2. Select the portal message to edit.
l In SSL VPN or WiFi interfaces, in Customize Portal Messages click the link to the portal messages that you

want to edit.
l In other interfaces, make sure that Customize Portal Messages is selected, select the adjacent Edit icon,

then select the message that you want to edit.

3. Edit the HTML message text, then select Save.
4. Select OK.

Configuring disclaimer page for ethernet interface captive portals

While you can customize a disclaimer page for captive portals that connect via WiFi, the same can be done for
wired connections. However, this can only be configured on the CLI Console, and only without configuring user
groups.

When configuring a captive portal through the CLI, you may set security-groups to a specific user group.
The result of this configuration will show an authentication form to users who wish to log in to the captive portal—
not a disclaimer page. If you do not set any security-groups in your configuration, an "Allow all" status will
be in effect, and the disclaimer page will be displayed for users.

The example CLI configuration below shows setting up a captive portal interface without setting security-groups,
resulting in a disclaimer page for users:

config system interface
edit "port1"

set vdom "root"
set ip 172.16.101.1 255.255.255.0
set allowaccess ping https ssh snmp http
set type physical
set explicit-web-proxy enable
set alias "LAN"
set security-mode captive-portal
set snmp-index 1

next
end

Roaming support

Client devices can maintain captive portal authentication as they roam across different APs. By maintaining a
consistent authentication, uninterrupted access to latency sensitive applications such as VoIP is ensured.

The Cloud will push a random per-AP Network encryption key to the AP. The key is 32 bytes in length, and is used
in captive portal fast roaming. All APs of an APNetwork will use the same encryption key. This key is randomly
generated, and will be updated daily.
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Configuration example - Captive portal WiFi access control
In this scenario, you will configure the FortiGate for captive portal access so users can log on to your WiFi
network.

You will create a user account (rgreen), add it to a user group (employees), create a captive portal SSID
(example-staff), and configure a FortiAP unit. When the user attempts to browse the Internet, they will be
redirected to the captive portal login page and asked to enter their username and password.
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1. Enabling HTTPS authentication

Go to User & Device > Authentication Settings.

Under Protocol Support, enable Redirect HTTP Challenge to a Secure Channel (HTTPS). This will
make sure that user credentials are communicated securely through the captive portal.

2. Creating the user

Go to User & Device > User Definition and create a Local user (rgreen).

Create additional users if needed, and assign any authentication methods.

3. Creating the user group

Go to User & Device > User Groups and create a user group (employees).

Add rgreen to the group.

4. Creating the SSID

Go toWiFi & Switch Controller > SSID and configure the wireless network.
Some FortiGate models may show the GUI path asWiFi & Switch Controller.

Enter an Interface Name (example-wifi) and IP/Network Mask.

An address range under DHCP Server will be automatically configured.

UnderWiFi Settings, enter an SSID name (example-staff), set Security Mode to Captive Portal, and
add the employees user group.

5. Creating the security policy

Go to Policy & Objects > Addresses and create a new address for the SSID (example-wifi-net).

Set Subnet/IP Range to the same range set on the DHCP server in the previous step.

Set Interface to the SSID interface.

Go to Policy & Objects > IPv4 Policy and create a new policy for WiFi users to connect to the Internet.

Add both the example-wifi-net address and employees user group to Source.

6. Connecting and authorizing the FortiAP

Go to Network > Interfaces and edit an available interface.

UnderAddress, set Addressing mode to Dedicated to Extension Device and assign it an IP address.
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Connect the FortiAP unit to the configured interface, then go toWiFi & Switch Controller > Managed
FortiAPs.

The FortiAP is listed, but itsState shows a greyed-out question mark— this is because it is waiting for
authorization.

Highlight the FortiAP and select Authorize.

The question mark is now replaced by a red down-arrow — this is because it is authorized, but still offline.

Go toWiFi & Switch Controller > FortiAP Profiles and edit the profile.

For each radio, enable Radio Resource Provision and select your SSID.

Go back toWiFi & Switch Controller > Managed FortiAPs to verify that the FortiAP unit is online.

7. Results

When a user attempts to connect to the wireless network, they will be redirected to the captive portal login
screen.

Members of the employees group must enter theirUsername and Password. The user will then be
redirected to the URL originally requested.

On the FortiGate, go to Monitor > WiFi Client Monitor to verify that the user is authenticated.
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When working with a FortiGate WiFi controller, you can configure your wireless network before you install any
access points. If you are working with a standalone FortiWiFi unit, the access point hardware is already present
but the configuration is quite similar. Both are covered in this section.

On FortiGate model 30D, web-based manager configuration of the WiFi controller is
disabled by default. To enable it, enter the following CLI commands:

config system global
  set gui-wireless-controller enable
end

The WiFi Controller and Switch Controller are enabled through the Feature Store
(under System > Feature Select). However, they are separately enabled and
configured to display in the GUI via the CLI.

To enable both WiFi and Switch controllers, enter the following:

config system global
set wireless-controller enable
set switch-controller enable

end

To enable the GUI display for both controllers, have also been separated:

config system settings
set gui-wireless-controller enable
set gui-switch-controller enable

end

If you want to connect and authorize external APs, such as FortiAP units, see the next chapter, Access point
deployment.

Overview of WiFi controller configuration
The FortiGate WiFi controller configuration is composed of three types of object, the SSID, the AP Profile and the
physical Access Point.

l An SSID defines a virtual wireless network interface, including security settings. One SSID is sufficient for a
wireless network, regardless how many physical access points are provided. You might, however, want to create
multiple SSIDs to provide different services or privileges to different groups of users. Each SSID has separate
firewall policies and authentication. Each radio in an access point can support up to 8 SSIDs.

Amore common use of the term SSID is for the identifier that clients must use to connect to the wireless network.
Each SSID (wireless interface) that you configure will have an SSID field for this identifier. In Managed Access
Point configurations you choose wireless networks by SSID values. In firewall policies you choose wireless
interfaces by their SSID name.
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l An AP Profile defines the radio settings, such as band (802.11g for example) and channel selection. The
AP Profile names the SSIDs to which it applies. Managed APs can use automatic profile settings or you can create
AP profiles.

l Managed Access Points represent local wireless APs on FortiWiFi units and FortiAP units that the FortiGate unit
has discovered. There is one managed access point definition for each AP device. An access point definition can
use automatic AP profile settings or select a FortiAP Profile. When automatic profile settings are used, the
managed AP definition also selects the SSIDs to be carried on the AP.

Conceptual view of FortiGate WiFi controller configuration

About SSIDs on FortiWiFi units

FortiWiFi units have a default SSID (wireless interface) namedwlan. You can modify or delete this SSID as
needed. As with external APs, the built-in wireless AP can be configured to carry any SSID.

The AP settings for the built-in wireless access point are located atWiFi Controller > Local WiFi Radio. The
available operational settings are the same as those for external access points which are configured at
WiFi Controller > Managed FortiAPs.

Process to create a wireless network

To set up your wireless network, you will need to perform the following steps:
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l Make sure the FortiGate wireless controller is configured for your geographic location. This ensures that the
available radio channels and radio power are in compliance with the regulations in your region.

l Optionally, if you don’t want to use automatic AP profile settings, configure a FortiAP profile, specifying the radio
settings and the SSIDs to which they apply.

l Configure one or more SSIDs for your wireless network. The SSID configuration includes DHCP and DNS settings.
l Configure the user group and users for authentication on the WLAN.
l Configure the firewall policy for the WLAN.
l Optionally, customize the captive portal.
l Configure access points.

Configuration of the built-in AP on FortiWiFi units is described in this chapter. Connection and configuration of
FortiAP units is described in the next chapter, see Access point deployment on page 1437.

Setting your geographic location
The maximum allowed transmitter power and permitted radio channels for WiFi networks depend on the region in
which the network is located. By default, the WiFi controller is configured for the United States. If you are located
in any other region, you need to set your location before you begin configuring wireless networks.

To change the location setting - CLI

To change the country to France, for example, enter

config wireless-controller setting
set country FR

end

To see the list of country codes, enter a question mark (‘?’) instead of a country code.

Before changing the country setting, you must remove all FortiAP Profiles. To do this,
go toWiFi & Switch Controller > FortiAP Profiles.

View all Country & Regcodes/Regulatory Domains

The following CLI command can be entered to view a list of the Country & Regcodes/Regulatory Domains
supported by Fortinet:

cw_diag -c all-countries

Below is a table showing a sample of the list displayed by entering this command:

Country-code Region-code Domain ISO-name Name

0 A FCC3 & FCCA NA NO_COUNTRY_SET

8 W NULL1 &WORLD AL ALBANIA

12 W NULL1 &WORLD DZ ALGERIA

16 A FCC3 & FCCA AS AMERICAN SAMOA

... ... ... ... ...
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Creating a FortiAP Profile
A FortiAP Profile defines radio settings for a particular platform (FortiAPmodel). The profile also selects which
SSIDs (virtual APs) the APs will carry. FortiAP units contain two radio transceivers, making it possible, for
example, to provide both 2.4GHz 802.11b/g/n and 5GHz 802.11a/n service from the same access point. The
radios can also be used for monitoring, used for the Rogue AP detection feature.

You can modify existing FortiAP profiles or create new ones of your own.

On FortiGate model 30D, web-based manager configuration of FortiAP Profiles is
disabled by default. To enable AP profiles, enter the following CLI commands:

config system settings
  set gui-ap-profile enable
end

To configure a FortiAP Profile - web-based manager

1. Go toWiFi & Switch Controller > FortiAP Profiles and select Create New.
2. Enter a Name for the FortiAP Profile.
3. In Platform, select the FortiWiFi or FortiAPmodel to which this profile applies.
4. If split tunneling is used, in Split Tunneling Subnets, enter a comma-separated list all of the destination IP

address ranges that should not be routed through the the FortiGate WiFi controller.
5. For each radio, enter:

Mode Select the type of mode.

Disable – radio disabled
Access Point – the platform is an access point
Dedicated Monitor – the platform is a dedicated monitor. See Wireless
network monitoring on page 1489.

WIDS Profile Optionally, select a Wireless Intrusion Detection (WIDS) profile. See
Protecting the WiFi Network on page 1485.

Radio Resource
Provision

Select to enable the radio resource provision feature. This feature
measures utilization and interference on the available channels and selects
the clearest channel at each access point. The measurement can be
repeated periodically to respond to changing conditions.

Client Load
Balancing

Select Frequency Handoff or AP Handoff as needed. See Access point
deployment on page 1437.

Band Select the wireless protocols that you want to support. The available
choices depend on the radio’s capabilities. Where multiple protocols are
supported, the letter suffixes are combined: “802.11g/b” means 802.11g
and 802.11b.

Note that on two-radio units such as the FortiAP-221C it is not possible to
put both radios on the same band.
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Channel Width Select channel width for 802.11ac or 802.11n on 5GHz.

Short Guard
Interval

Select to enable the short guard interval for 802.11ac or 802.11n on 5GHz.

Channels Select the channel or channels to include. The available channels depend
on which IEEEwireless protocol you selected in Band. By default, all
available channels are enabled.

TX Power
Control

Enable automatic or manual adjustment of transmit power, specifying
either minimum and maximum power levelsin dBm or as a percentage.

TX Power When TX Power Control is set to Auto, the TX Power is set by default
to a range of 10-17 dBm. Set the range between 1-20 for both the lower
and upper limits.

When TX Power Control is set toManual, the TX Power is set by
default to 100% of the maximum power permitted in your region. To
change the level, drag the slider.

SSIDs Select between Auto orManual. Selecting Auto eliminates the need to
re-edit the profile when new SSIDs are created. However, you can still
select SSIDs individually usingManual.

Note that automatic assignment of SSIDs (Auto) is not available for
FortiAPs in Local Bridgemode. The option is hidden on both the
Managed FortiAP settings and the FortiAP Profile assigned to that AP.

Radio 1 settings are the same as Radio 2 settings except for the options forChannel.
Radio 2 settings are available only for FortiAPmodels with dual radios.

6. Select OK.

To configure a FortiAP Profile - CLI

This example configures a FortiAP-220B to carry all SSIDs on Radio 1 but only SSID example_wlan on Radio 2.

config wireless-controller wtp-profile
edit guest_prof

config platform
set type 220B

end
config radio-1

set mode ap
set band 802.11g
set vap-all enable

end
config radio-2

set mode ap
set band 802.11g
set vaps example_wlan

end
end
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Defining a wireless network interface (SSID)
You begin configuring your wireless network by defining one or more SSIDs to which your users will connect.
When you create an SSID, a virtual network interface is also created with the Name you specified in the SSID
configuration. You can configure the settings of an existing SSID in eitherWiFi Controller > WiFi Network >
SSID or System > Network > Interface.

If a software switch interface contains an SSID (but only one), the WiFi SSID settings
are available in the switch interface settings.

To create a new SSID

1. Go toWiFi & Switch Controller > SSID and select Create New > SSID.
2. Fill in the SSID fields as described below.

To configure the settings of an existing SSID

1. Either
l Go toWiFi & Switch Controller > SSID.

or

l Go to Network > Interfaces.
WiFi interfaces list the SSID beside the interface Name.

2. Edit a WiFi interface, modifying the SSID fields as needed.

SSID fields

Interface Name Enter a name for the SSID interface.

Type WiFi SSID.

Traffic Mode Tunnel to Wireless Controller — Data for WLAN passes through WiFi Controller.
This is the default.

Local bridge with FortiAP’s Interface— FortiAP unit Ethernet and WiFi interfaces
are bridged.

Mesh Downlink— Radio receives data for WLAN from mesh backhaul SSID.

IP/Network Mask Enter the IP address and netmask for the SSID.

IPv6 Address Enter the IPv6 address. This is available only when IPv6 has been enabled on the unit.

Administrative
Access Select which types of administrative access are permitted on this SSID.
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IPv6
Administrative
Access

If you have IPv6 addresses, select the permitted IPv6 administrative access types for
this SSID.

DHCP Server

To assign IP addresses to clients, enable DHCP server. You can define IP address
ranges for a DHCP server on the FortiGate unit or relay DHCP requests to an external
server.

If the unit is in transparent mode, the DHCP server settings will be unavailable.

For more information, see Configuring DHCP for WiFi clients on page 1422.

Device Detection Detect connected device type. Enabled by default.

Active Scanning Enabled by default.

WiFi Settings

SSID Enter the SSID. By default, this field contains fortinet.

Security Mode Select the security mode for the wireless interface. Wireless users must use the same
security mode to be able to connect to this wireless interface. Additional security mode
options are available in the CLI. For more information, see Configuring security on
page 1423.

Captive Portal – authenticates users through a customizable web page.

WPA2-Personal – WPA2 isWiFi Protected Access version 2. There is one pre-shared
key (password) that all users use.

WPA2-Personal with Captive Portal – The user will need to know the pre-shared
key and will also be authenticated through the custom portal.

WPA2-Enterprise – similar to WPA2-Personal, but is best used for enterprise
networks. Each user is separately authenticated by user name and password.

Pre-shared Key Available only when Security Mode isWPA2-Personal. Enter the encryption key
that the clients must use.

Authentication Available only when Security Mode isWPA2-Enterprise.

Select one of the following:

RADIUS Server — Select the RADIUS server that will authenticate the clients.
Local – Select the user group(s) that can authenticate.

Portal Type Available only when Security Mode isCaptive Portal. Choose the captive portal
type. Authentication is available with or without a usage policy disclaimer notice.
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Authentication
Portal

Local - portal hosted on the FortiGate unit
External - enter FQDN or IP address of external portal

User Groups Select permitted user groups for captive portal authentication.

Exempt List Select exempt lists whose members will not be subject to captive portal
authentication.

Customize Portal
Messages Click the listed portal pages to edit them.

Redirect after
Captive Portal

Optionally, select Specific URL and enter a URL for user redirection after captive
portal authentication. By default, users are redirected to the URL that they originally
requested.

Allow New WiFi
Client
Connections
When Controller
Is Down

This option is available for local bridge SSIDs with WPA-Personal security. See
Combining WiFi and wired networks with a software switch on page 1470.

Broadcast SSID Optionally, disable broadcast of SSID. By default, the SSID is broadcast. For more
information, see Introduction to wireless networking on page 1397.

Schedule Select when the SSID is enabled. You can choose any schedule defined in Policy &
Objects > Objects > Schedules.

Block Intra-SSID
Traffic

Select to enable the unit to block intra-SSID traffic.

Maximum Clients Select to limit the number of clients permitted to connect simultaneously. Enter the
limit value.

Split Tunneling Select to enable some subnets to remain local to the remote FortiAP. Traffic for these
networks is not routed through the WiFi Controller. Specify split-tunnel networks in the
FortAP Profile. See Split tunneling on page 1476.

Optional VLAN ID Enter the ID of the VLAN this SSID belongs to. Enter 0 for non-VLAN operation.

Enable Explicit
Web Proxy

Select to enable explicit web proxy for the SSID.

Listen for
RADIUS
Accounting
Messages

Enable if you are using RADIUS-based Single Sign-On (SSO).

Secondary IP
Address

Optioanally, enable and define secondary IP addresses. Administrative access can be
enabled on secondary interfaces.
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Comments Enter a description or comment for the SSID.

To configure a virtual access point (SSID) - CLI

The example below creates an access point with SSID “example” and WPA2-Personal security. The wireless
interface is named example_wlan.

WiFi SSIDs include a schedule that determines when the WiFi network is available. The default schedule is
Always. You can choose any schedule (but not schedule group) that is defined in Policy & Objects > Objects >
Schedules.

config wireless-controller vap
edit example_wlan

set ssid "example"
set broadcast-ssid enable
set security wpa2-only-personal
set passphrase "hardtoguess”
set schedule always
set vdom root

end
config system interface

edit example_wlan
set ip 10.10.120.1 255.255.255.0

end

Configuring DHCP for WiFi clients

Wireless clients need to have IP addresses. If you use RADIUS authentication, each user’s IP address can be
stored in the Framed-IP-Address attribute. Otherwise, you need to configure a DHCP server on the WLAN
interface to assign IP addresses to wireless clients.

To configure a DHCP server for WiFi clients - web-based manager

1. Go toWiFi & Switch Controller > SSID and edit your SSID entry.
2. In DHCP Server select Enable.
3. In Address Range, select Create New.
4. In the Starting IP and End IP fields, enter the IP address range to assign.

By default an address range is created in the same subnet as the wireless interface IP address, but not including
that address.

5. Set the Netmask to an appropriate value, such as 255.255.255.0.
6. Set the Default Gateway to Same as Interface IP.
7. Set the DNS Server to Same as System DNS.
8. If you want to restrict access to the wireless network by MAC address, see Adding a MAC filter on page 1425.
9. Select OK.

To configure a DHCP server for WiFi clients - CLI

In this example, WiFi clients on the example_wlan interface are assigned addresses in the 10.10.120.2-9 range
to connect with the WiFi access point on 10.10.120.1.

config system dhcp server
edit 0

set default-gateway 10.10.120.1
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set dns-service default
set interface example_wlan
set netmask 255.255.255.0
config ip-range

edit 1
set end-ip 10.10.120.9
set start-ip 10.10.120.2

end
end

You cannot delete an SSID (wireless interface) that has DHCP enabled on it.

Configuring security

Using the web-based manager, you can configure Captive Portal security or WiFi Protected Access version 2
(WPA2) security modesWPA2-Personal and WPA2-Enterprise. Using the CLI, you can also choose WPA/WPA2
modes that support both WPA version 1 and WPA version 2.

WPA2 security with a pre-shared key for authentication is called WPA2-Personal. This can work well for one
person or a small group of trusted people. But, as the number of users increases, it is difficult to distribute new
keys securely and there is increased risk that the key could fall into the wrong hands.

Amore secure form of WPA2 security is WPA2-Enterprise. Users each have their own authentication credentials,
verified through an authentication server, usually RADIUS. FortiOS can also authenticate WPA2-Enterprise users
through its built-in user group functionality. FortiGate user groups can include RADIUS servers and can select
users by RADIUS user group. This makes possible Role-Based Access Control (RBAC).

By default, WPA2 security encrypts communication using Advanced Encryption Standard (AES). But some older
wireless clients support only Temporal Key Integrity Protocol (TKIP) . You can change the encryption to TKIP or
negotiable TKIP-AES in the CLI. For example, to accomodate clients with either TKIP or AES, enter:

config wireless-controller vap
edit example_wlan

set security wpa-personal
set passphrase "hardtoguess"
set encrypt TKIP-AES

end

Captive Portal security connects users to an open web portal defined in replacement messages. To navigate to
any location beyond the web portal, the user must pass FortiGate user authentication.

WPA-Personal security

WPA2-Personal security setup requires only the preshared key that you will provide to your clients.

To configure WPA2-Personal security - web-based manager

1. Go toWiFi & Switch Controller > SSID and edit your SSID entry.
2. In Security Mode, selectWPA2 Personal.
3. In Pre-shared Key, enter a key between 8 and 63 characters long.
4. Select OK.
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To configure WPA2-Personal security - CLI

config wireless-controller vap
edit example_wlan

set security wpa2-personal
set passphrase "hardtoguess"

end

WPA-Enterprise security

If you will use FortiOS user groups for authentication, go to User & Device > User > User Groups and create
those groups first. The groups should be Firewall groups.

If you will use a RADIUS server to authenticate wireless clients, you must first configure the FortiGate unit to
access the RADIUS server.

To configure FortiGate unit access to the RADIUS server - web-based manager

1. Go to User & Device > RADIUS Servers and select Create New.
2. Enter a Name for the server.
3. In Primary Server Name/IP, enter the network name or IP address for the server.
4. In Primary Server Secret, enter the shared secret used to access the server.
5. Optionally, enter the information for a secondary or backup RADIUS server.
6. Select OK.

To configure the FortiGate unit to access the RADIUS server - CLI

config user radius
edit exampleRADIUS

set auth-type auto
set server 10.11.102.100
set secret aoewmntiasf

end

RADIUS Change of Authorization (CoA) support

The CoA feature enables the FortiGate to receive a client disconnect message from the RADIUS server. This is
used to disconnect clients when their time, credit or bandwidth had been used up. Enable this on the RADIUS
server using the CLI:

config user radius
edit <name>

set radius-coa enable
end

To configure WPA-Enterprise security - web-based manager

1. Go toWiFi & Switch Controller > SSIDand edit your SSID entry.
2. In Security Mode, selectWPA2 Enterprise.
3. In Authentication, do one of the following:

l If you will use a RADIUS server for authentication, select RADIUS Server and then select the RADIUS server.
l If you will use a local user group for authentication, select Local and then select the user group(s) permitted to

use the wireless network.
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4. Select OK.

To configure WPA-Enterprise security - CLI

config wireless-controller vap
edit example_wlan

set security wpa2-enterprise
set auth radius
set radius-server exampleRADIUS

end

Captive Portal security

Captive Portal security provides an access point that initially appears open. The wireless client can connect to the
APwith no security credentials. The AP responds to the client’s first HTTP request with a web page requesting
user name and password. Until the user enters valid credentials, no communication beyond the AP is permitted.

The captive portal can be hosted on the FortiGate unit, or externally. For details see

Configuring WiFi captive portal security - FortiGate captive portal on page 1427

Configuring WiFi captive portal security - external server on page 1427

For general information about captive portals, see the Captive Portal chapter of the Authentication Guide.

Adding a MAC filter

On each SSID, you can create a MAC address filter list to either permit or exclude a list of clients identified by
their MAC addresses.

This is actually not as secure as it appears. Someone seeking unauthorized access to your network can obtain
MAC addresses from wireless traffic and use them to impersonate legitimate users. AMAC filter list should only
be used in conjunction with other security measures such as encryption.

To configure a MAC filter - web-based manager

1. Go toWiFi & Switch Controller > SSID and edit your SSID entry.
2. In the DHCP Server section, expand Advanced.
3. InMAC Reservation + Access Control, double-click in the Unknown MAC Addresses line and select

Assign IP orBlock, as needed.
By default, unlisted MAC addresses are assigned an IP address automatically.

4. InMAC Reservation + Access Control, select Create New.
5. Enter a MAC address In theMAC field.
6. In IP or Action, select one of:

l Reserve IP— enter the IP address that is always assigned to this MAC address.
l Assign IP — an IP address is assigned to this MAC address automatically.
l Block— This MAC address will not be assigned an IP address.

7. Repeat steps 4 through 6 for each additional MAC address that you want to add.
8. Select OK.

To configure a MAC filter - CLI

1. Enter
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config system dhcp server
show

2. Find the entry where interface is your WiFi interface. Edit that entry and configure the MAC filter. In this
example, the MAC address 11:11:11:11:11:11will be excluded. Unlisted MAC addresses will be assigned an IP
address automatically.

edit 3
config reserved-address

edit 1
set action block
set mac 11:11:11:11:11:11

end
set mac-acl-default-action assign

end

Limiting the number of clients

You might want to prevent overloading of your access point by limiting the number of clients who can associate
with it at the same time. Limits can be applied per SSID, per AP, or per radio.

To limit the number of clients per SSID - GUI

1. Go toWiFi & Switch Controller > SSID and edit your SSID.
2. Turn onMaximum Clients and enter the maximum number of clients in Limit Concurrent WiFi Clients.

To limit the number of clients per AP- CLI

Edit the wtp-profile (FortiAP profile), like this:

config wireless-controller wtp-profile
edit "FAP221C-default"

set max-clients 30
end

To limit the number of clients per radio - CLI

Edit the wtp-profile (FortiAP profile), like this:

config wireless-controller wtp-profile
edit "FAP221C-default"

config radio-1
set max-clients 10

end
config radio-2

set max-clients 30
end

end

Multicast enhancement

FortiOS can translate multicast traffic into unicast traffic to send to clients, maintaining its own multicast client
through IGMP snooping. You can configure this in the CLI:

config wireless-controller vap
edit example_wlan

set multicast-enhance enable
set me-disable-thresh 32
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end

If the number of clients on the SSID is larger than me-disable-thresh, multicast enhancement is disabled.

Configuring WiFi captive portal security - FortiGate captive portal

The built-in FortiGate captive portal is simpler than an external portal. It can even be customized if needed.

To configure a WiFi Captive Portal - web-based manager:

1. Go toWiFi & Switch Controller > SSID and create your SSID.
If the SSID already exists, you can edit the SSID or you can edit the WiFi interface in Network > Interfaces.

2. In Security Mode, select Captive Portal.
3. Enter

Portal Type The portal can provide authentication and/or disclaimer, or perform user
email address collection. See Defining a wireless network interface (SSID)
on page 1419.

Authentication Portal Local

User Groups Select permitted user groups or select Use Groups from Policies, which
permits the groups specified in the security policy.

Exempt List Select exempt lists whose members will not be subject to captive portal
authentication.

Customize Portal Messages Click the link of the portal page that you want to modify. For more
information see the Captive Portal chapter of the Authentication Guide.

4. Select OK.

Configuring WiFi captive portal security - external server

An external captive portal is a web page on a web server. The essential part of the web portal page is a script that
gathers the user’s logon credentials and sends back to the FortiGate a specifically-formatted POST message.
The portal page can also contain links to local information such as legal notices, terms of service and so on.
Without authenticating, the user cannot access any other information. This is sometimes called a “walled
garden”.

On the captive portal page, the user submits credentials, which the script returns to the FortiGate at the URL
https://<FGT_IP>:1000/fgtauth with data
magic=session_id&username=<username>&password=<password>.
(The magic value was provided in the initial FortiGate request to the web server.)

To ensure that credentials are communicated securely, enable the use of HTTPS for authentication:

config user setting
set auth-secure-http enable

end
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To configure use of an external WiFi Captive Portal - web-based manager:

1. Go toWiFi & Switch Controller > SSIDand create your SSID.
If the SSID already exists, you can edit the SSID or you can edit the WiFi interface in Network > Interfaces.

2. In Security Mode, select Captive Portal.
3. Enter

Portal Type The portal can provide authentication and/or disclaimer, or perform user
email address collection.

Authentication Portal External - enter the FQDN or IP address of the external portal. Typically,
this is the URL of a script. Do not include the protocol (http:// or https://)
part of the URL.

User Groups Select permitted user groups or select Use Groups from Policies, which
permits the groups specified in the security policy.

Exempt List Select exempt lists whose members will not be subject to captive portal
authentication.

Redirect after Captive Portal Original Request

Specific URL - enter URL

4. Select OK.

Defining SSID Groups
Optionally, you can define SSID Groups. An SSID Group has SSIDs as members and can be specified just like an
SSID in a FortiAP Profile.

To create an SSID Group - GUI

Go toWiFi & Switch Controller > SSID and select Create New > SSID Group. Give the group a Name and
chooseMembers (SSIDs, but not SSID Groups).

To create an SSID Group - CLI:

config wireless-controller vap-group
edit vap-group-name

set vaps "ssid1" "ssid2"
end

Dynamic user VLAN assignment
Clients connecting to the WiFi network can be assigned to a VLAN. You can do this with RADIUS attributes when
the user authenticates or with VLAN pooling when the client associates with a particular FortiAP. You cannot use
both of these methods at the same time.
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VLAN assignment by RADIUS

You can assign each individual user to a VLAN based on information stored in the RADIUS authentication server.
If the user’s RADIUS record does not specify a VLAN ID, the user is assigned to the default VLAN for the SSID.

The RADIUS user attributes used for the VLAN ID assignment are: 

IETF 64 (Tunnel Type)—Set this to VLAN.  

IETF 65 (Tunnel Medium Type)—Set this to 802  

IETF 81 (Tunnel Private Group ID)—Set this to the VLAN ID.  

To configure dynamic VLAN assignment, you need to:

1. Configure access to the RADIUS server.
2. Create the SSID and enable dynamic VLAN assignment.
3. Create a FortiAP Profile and add the local bridge mode SSID to it.
4. Create the VLAN interfaces and their DHCP servers.
5. Create security policies to allow communication from the VLAN interfaces to the Internet.
6. Authorize the FortiAP unit and assign the FortiAP Profile to it.

To configure access to the RADIUS server

1. Go to User & Device > RADIUS Servers and select Create New.
2. Enter a Name, the name or IP address in Primary Server IP/Name, and the server secret in Primary Server

Secret.
3. Select OK.

To create the dynamic VLAN SSID

1. Go to WiFi & Switch Controller > SSID, select Create New > SSID and enter:

Name An identifier, such as dynamic_vlan_ssid.

Traffic Mode Local bridge or Tunnel, as needed.

SSID An identifier, such as DYNSSID.

Security Mode WPA2 Enterprise

Authentication RADIUS Server. Select the RADIUS server that you configured.

2. Select OK.
3. Enable dynamic VLAN in the CLI. Optionally, you can also assign a VLAN ID to set the default VLAN for users

without a VLAN assignment.
config wireless-controller vap

edit dynamic_vlan_ssid
set dynamic-vlan enable
set vlanid 10

end
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To create the FortiAP profile for the dynamic VLAN SSID

1. Go to WiFi & Switch Controller > FortiAP Profiles, select Create New and enter:

Name A name for the profile, such as dyn_vlan_profile.

Platform The FortiAPmodel you are using. If you use more than one model of
FortiAP, you will need a FortiAP Profile for each model.

Radio 1 and Radio 2

SSID Select the SSID you created (example dynamic_vlan_ssid). Do not add
other SSIDs.

2. Adjust other radio settings as needed.
3. Select OK.

To create the VLAN interfaces

1. Go to Network > Interfaces and select Create New > Interface.
2. Enter:

Name A name for the VLAN interface, such as VLAN100.

Interface The physical interface associated with the VLAN interface.

VLAN ID The numeric VLAN ID, for example 100.

Addressing mode Select Manual and enter the IP address / Network Mask for the virtual
interface.

DHCP Server Enable and then select Create New to create an address range.

3. Select OK.
4. Repeat the preceding steps to create other VLANs as needed.
Security policies determine which VLANs can communicate with which other interfaces. These are the simple
Firewall Address policy without authentication. Users are assigned to the appropriate VLAN when they
authenticate.

To connect and authorize the FortiAP unit

1. Connect the FortiAP unit to the FortiGate unit.
2. Go toWiFi & Switch Controller > Managed FortiAPs.
3. When the FortiAP unit is listed, double-click the entry to edit it.
4. In FortiAP Profile, select the FortiAP Profile that you created.
5. Select Authorize.
6. Select OK.
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VLAN assignment by VLAN pool

In an SSID, you can define a VLAN pool. As clients associate to an AP, they are assigned to a VLAN. A VLAN pool
can

l assign a specific VLAN based on the AP's FortiAPGroup, usually for network configuration reasons, or
l assign one of several available VLANs for network load balancing purposes (tunnel mode SSIDs only)

To assign a VLAN by FortiAP Group - CLI

In this example, VLAN 101, 102, or 103 is assigned depending on the AP's FortiAPGroup.

config wireless-controller vap
edit wlan

set vlan-pooling wtp-group
config vlan-pool

edit 101
set wtp-group wtpgrp1

next
edit 102

set wtp-group wtpgrp2
next
edit 101

set wtp-group wtpgrp3
end

end
end

Load balancing

There are two VLAN pooling methods used for load balancing:

The choice of VLAN can be based on any one of the following criteria:

l round-robin - from the VLAN pool, choose the VLAN with the smallest number of clients
l hash - choose a VLAN from the VLAN pool based on a hash of the current number of SSID clients and the number

of entries in the VLAN pool

If the VLAN pool contains no valid VLAN ID, the SSID's static VLAN ID setting is used.

To assign a VLAN by round-robin selection - CLI

In this example, VLAN 101, 102, or 103 is assigned using the round-robin method:

config wireless-controller vap
edit wlan

set vlan-pooling round-robin
config vlan-pool

edit 101
next
edit 102
next
edit 103
end

end
end
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To assign a VLAN by hash-based selection - CLI

In this example, VLAN 101, 102, or 103 is assigned using the hash method:

config wireless-controller vap
edit wlan

set vlan-pooling hash
config vlan-pool

edit 101
next
edit 102
next
edit 103
end

end
end

Configuring user authentication
You can perform user authentication when the wireless client joins the wireless network and when the wireless
user communicates with another network through a firewall policy. WEP and WPA-Personal security rely on
legitimate users knowing the correct key or passphrase for the wireless network. The more users you have, the
more likely it is that the key or passphrase will become known to unauthorized people. WPA-Enterprise and
captive portal security provide separate credentials for each user. User accounts can be managed through
FortiGate user groups or an external RADIUS authentication server.

WPA2 Enterprise authentication

Enterprise authentication can be based on the local FortiGate user database or on a remote RADIUS server.
Local authentication is essentially the same for WiFi users as it is for wired users, except that authentication for
WiFi users occurs when they associate their device with the AP. Therefore, enterprise authentication must be
configured in the SSID. WiFi users can belong to user groups just the same as wired users and security policies
will determine which network services they can access.

If your WiFi network usesWPA2 Enterprise authentication verified by a RADIUS server, you need to configure the
FortiGate unit to connect to that RADIUS server.

Configuring connection to a RADIUS server - web-based manager

1. Go to User & Device > RADIUS Servers and select Create New.
2. Enter a Name for the server.

This name is used in FortiGate configurations. It is not the actual name of the server.
3. In Primary Server Name/IP, enter the network name or IP address for the server.
4. In Primary Server Secret, enter the shared secret used to access the server.
5. Optionally, enter the information for a secondary or backup RADIUS server.
6. Select OK.

To configure the FortiGate unit to access the RADIUS server - CLI

config user radius
edit exampleRADIUS

set auth-type auto
set server 10.11.102.100
set secret aoewmntiasf
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end

To implement WPA2 Enterprise security, you select this server in the SSID security settings. See Configuring user
authentication on page 1432.

To use the RADIUS server for authentication, you can create individual FortiGate user accounts that specify the
authentication server instead of a password, and you then add those accounts to a user group. Or, you can add
the authentication server to a FortiGate user group, making all accounts on that server members of the user
group.

Creating a wireless user group

Most wireless networks require authenticated access. To enable creation of firewall policies specific to WiFi
users, you should create at least one WiFi user group. You can add or remove users later. There are two types of
user group to consider:

l A Firewall user group can contain user accounts stored on the FortiGate unit or external authentication servers such
as RADIUS that contain and verify user credentials.

l A Fortinet Single Sign-On (FSSO) user group is used for integration with Windows Active Directory or Novell
eDirectory. The group can contain Windows or Novell user groups who will be permitted access to the wireless LAN.

WiFi Single Sign-On (WSSO) authentication

WSSO is RADIUS-based authentication that passes the user's user group memberships to the FortiGate. For
each user, the RADIUS server must provide user group information in the Fortinet-Group-Name attribute. This
information is stored in the server's database. After the user authenticates, security policies provide access to
network services based on user groups.

1. Configure the RADIUS server to return the Fortinet-Group-Name attribute for each user.
2. Configure the FortiGate to access the RADIUS server, as described in WPA2 Enterprise authentication on page

1432.
3. Create firewall user groups on the FortiGate with the same names as the user groups listed in the RADIUS

database. Leave the groups empty.
4. In the SSID choose WPA2-Enterprise authentication. In the Authentication field, select RADIUS Server and

choose the RADIUS server that you configured.
5. Create security policies as needed, using user groups (Source User(s) field) to control access.
When a user authenticates byWSSO, the firewall monitorMonitor > Firewall User Monitor) shows the
authentication method asWSSO.

Assigning WiFi users to VLANs dynamically

Some enterprise networks use Virtual LANs (VLANs) to separate traffic. In this environment, to extend network
access to WiFi users might appear to require multiple SSIDs. But it is possible to automatically assign each user
to their appropriate VLAN from a single SSID. To accomplish this requires RADIUS authentication that passes the
appropriate VLAN ID to the FortiGate by RADIUS attributes. Each user’s VLAN assignment is stored in the user
database of the RADIUS server.

1. Configure the RADIUS server to return the following attributes for each user:
Tunnel-Type (value: VLAN)
Tunnel-Medium-Type (value: IEEE-802)
Tunnel_Private-Group-Id (value: the VLAN ID for the user's VLAN)

2. Configure the FortiGate to access the RADIUS server.
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3. Configure the SSID with WPA2-Enterprise authentication. In the Authentication field, select RADIUS Server
and choose the RADIUS server that you will use.

4. Create VLAN subinterfaces on the SSID interface, one for each VLAN. Set the VLAN ID of each as appropriate.
You can do this on the Network > Interfaces page.

5. Enable Dynamic VLAN assignment for the SSID. For example, if the SSID interface is "office", enter:
config wireless-controller vap

edit office
set dynamic-vlan enable

end

6. Create security policies for each VLAN. These policies have a WiFI VLAN subinterface as Incoming Interface
and allow traffic to flow to whicheverOutgoing Interface these VLAN users will be allowed to access.

MAC-based authentication

Wireless clients can also be supplementally authenticated by MAC address. A RADIUS server stores the allowed
MAC address for each client and the wireless controller checks the MAC address independently of other
authentication methods.

MAC-based authentication must be configured in the CLI. In the following example, MAC-based authentication is
added to an existing access point “vap1” to use RADIUS server hq_radius (configured on the FortiGate):

config wireless-controller vap
edit vap1

set radius-mac-auth enable
set radius-mac-auth-server hq_radius

end

Authenticating guest WiFi users

The FortiOSGuest Management feature enables you to easily add guest accounts to your FortiGate unit. These
accounts are authenticate guest WiFi users for temporary access to a WiFi network managed by a FortiGate unit.
To implement guest access, you need to

1. Go to User & Device > User Groups and create one or more guest user groups.
2. Go to User & Device > Guest Management to create guest accounts. You can print the guest account

credentials or send them to the user as an email or SMSmessage.
3. Go toWiFi & Switch Controller > SSID and configure your WiFi SSID to use captive portal authentication.

Select the guest user group(s) that you created.
Guest users can log into the WiFi captive portal with their guest account credentials until the account expires. For
more detailed information about creating guest accounts, see “Managing Guest Access” in the Authentication
chapter of the FortiOS Handbook.

Configuring firewall policies for the SSID
For users on the WiFi LAN to communicate with other networks, firewall policies are required. This section
describes creating a WiFi network to Internet policy.

Before you create firewall policies, you need to define any firewall addresses you will need.

To create a firewall address for WiFi users - web-based manager

1. Go to Policy & Objects > Addresses.
2. Select Create New, enter the following information and select OK.
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Name Enter a name for the address, wifi_net for example.

Type Select Subnet.

Subnet / IP Range Enter the subnet address, 10.10.110.0/24 for example.

Interface Select the interface where this address is used, e.g., example_wifi

To create a firewall address for WiFi users - CLI

config firewall address
edit "wifi_net"

set associated-interface "example_wifi"
set subnet 10.10.110.0 255.255.255.0

end

To create a firewall policy - web-based manager

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. In Incoming Interface, select the wireless interface.
3. In Source Address, select the address of your WiFi network, wifi_net for example.
4. InOutgoing Interface, select the Internet interface, for example, port1.
5. In Destination Address, select All.
6. In Service, select ALL, or select the particular services that you want to allow, and then select the right arrow

button to move the service to the Selected Services list.
7. In Schedule, select always, unless you want to define a schedule for limited hours.
8. In Action, select ACCEPT.
9. Select Enable NAT.
10. Optionally, set up UTM features for wireless users.
11. Select OK.

To create a firewall policy - CLI

config firewall policy
edit 0

set srcintf "example_wifi"
set dstintf "port1"
set srcaddr "wifi_net"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"
set nat enable

end

Configuring the built-in access point on a FortiWiFi unit
Both FortiGate and FortiWiFi units have the WiFi controller feature. If you configure a WiFi network on a
FortiWiFi unit, you can also use the built-in wireless capabilities in your WiFi network as one of the access points.
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If Virtual Domains are enabled, you must select the VDOM to which the built-in access point belongs. You do this
in the CLI. For example:

config wireless-controller global
set local-radio-vdom vdom1

end

To configure the FortiWiFi unit’s built-in WiFi access point

1. Go toWiFi Controller > Local WiFi Radio.
2. Make sure that Enable WiFi Radio is selected.
3. In SSID, if you do not want this AP to carry all SSIDs, select Select SSIDs and then select the required SSIDs.
4. Optionally, adjust the TX Power slider.

If you have selected your location correctly (see Configuring the built-in access point on a FortiWiFi unit on page
1435), the 100% setting corresponds to the maximum power allowed in your region.

5. If you do not want the built-in WiFi radio to be used for rogue scanning, select Do not participate in Rogue AP
scanning.

6. Select OK.
If you want to connect external APs, such as FortiAP units, see the next chapter, Access point deployment.
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This chapter describes how to configure access points for your wireless network.

Overview
FortiAP units discover WiFi controllers. The administrator of the WiFi controller authorizes the FortiAP units that
the controller will manage.

In most cases, FortiAP units can find WiFi controllers through the wired Ethernet without any special
configuration. Review the following section, Access point deployment on page 1437, to make sure that your
method of connecting the FortiAP unit to the WiFi controller is valid. Then, you are ready to follow the procedures
in Access point deployment on page 1437.

If your FortiAP units are unable to find the WiFi controller, refer to Access point deployment on page 1437 for
detailed information about the FortiAP unit’s controller discovery methods and how you can configure them.

Network topology for managed APs
The FortiAP unit can be connected to the FortiGate unit in any of the following ways:

Direct connection: The FortiAP unit is directly connected to the FortiGate unit with no switches between them.
This configuration is common for locations where the number of FortiAP’s matches up with the number of
‘internal’ ports available on the FortiGate. In this configuration the FortiAP unit requests an IP address from the
FortiGate unit, enters discovery mode and should quickly find the FortiGate WiFi controller. This is also known as
a wirecloset deployment. See "Wirecloset and Gateway deployments" below.
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Wirecloset deployment

Switched Connection: The FortiAP unit is connected to the FortiGate WiFi controller by an Ethernet switch
operating in L2 switching mode or L3 routing mode. There must be a routable path between the FortiAP unit and
the FortiGate unit and ports 5246 and 5247 must be open. This is also known as a gateway deployment. See
Gateway Deployment below.
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Gateway Deployment
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Connection over WAN: The FortiGate WiFi controller is off-premises and connected by a VPN tunnel to a local
FortiGate. In this method of connectivity its best to configure each FortiAP with the static IP address of the WiFi
controller. Each FortiAP can be configured with three WiFi controller IP addresses for redundant failover. This is
also known as a datacenter remote management deployment. See Remote deployment below.

Remote deployment

Discovering and authorizing APs
After you prepare your FortiGate unit, you can connect your APs to discover them using the discovery methods
described earlier. To prepare the FortiGate unit, you need to

l Configure the network interface to which the APwill connect.
l Configure DHCP service on the interface to which the APwill connect.
l Optionally, preauthorize FortiAP units. They will begin to function when connected.
l Connect the AP units and let the FortiGate unit discover them.
l Enable each discovered AP and configure it or assign it to an AP profile.

Configuring the network interface for the AP unit

The interface to which you connect your wireless access point needs an IP address. No administrative access,
DNSQuery service or authentication should be enabled.
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To configure the interface for the AP unit - web-based manager

1. Go to Network > Interfaces and edit the interface to which the AP unit connects.
2. Set Addressing Mode to Dedicate to Extension Device.
3. Enter the IP address and netmask to use.

This FortiGate unit automatically configures a DHCP server on the interface that will assign the remaining higher
addresses up to .254 to FortiAP units. For example, if the IP address is 10.10.1.100, the FortiAP units will be
assigned 10.10.1.101 to 10.10.1.254. To maximize the available addresses, use the .1 address for the interface:
10.10.1.1, for example.

4. Select OK.

To configure the interface for the AP unit - CLI

In the CLI, you must configure the interface IP address and DHCP server separately.

config system interface
edit port3

set mode static
set ip 10.10.70.1 255.255.255.0

end
config system dhcp server

edit 0
set interface "dmz"
config ip-range

edit 1
set end-ip 10.10.70.254
set start-ip 10.10.70.2

end
set netmask 255.255.255.0
set vci-match enable
set vci-string "FortiAP"

end

The optional vci-match and vci-string fields ensure that the DHCP server will provide IP addresses only
to FortiAP units.

Pre-authorizing a FortiAP unit

If you enter the FortiAP unit information in advance, it is authorized and will begin to function when it is
connected.

To pre-authorize a FortiAP unit

1. Go toWiFi & Switch Controller > Managed FortiAPs and select Create New.
On some models theWiFi Controllermenu is calledWiFi & Switch Controller.

2. Enter the Serial Number of the FortiAP unit.
3. Configure theWireless Settings as required.
4. Select OK.

Enabling and configuring a discovered AP

Within two minutes of connecting the AP unit to the FortiGate unit, the discovered unit should be listed on
WiFi Controller > Managed FortiAPs page. After you select the unit, you can authorize, edit or delete it.
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Discovered access point unit

When you authorize (enable) a FortiAP unit, it is configured by default to use the default FortiAP profile
(determined by model). You can create and select a different profile if needed. The FortiAP Profile defines the
entire configuration for the AP.

To add and configure the discovered AP unit - web-based manager

1. Go toWiFi & Switch Controller > Managed FortiAPs.
This configuration also applies to local WiFi radio on FortiWiFi models.

2. Select the FortiAP unit from the list and edit it.
3. Optionally, enter a Name. Otherwise, the unit will be identified by serial number.
4. Select Authorize.
5. Select a FortiAP Profile.
6. Select OK.
The physical access point is now added to the system. If the rest of the configuration is complete, it should be
possible to connect to the wireless network through the AP.

To add the discovered AP unit - CLI

First get a list of the discovered access point unit serial numbers:

get wireless-controller wtp

Add a discovered unit and associate it with AP-profile1, for example:

config wireless-controller wtp
edit FAP22A3U10600118

set admin enable
set wtp-profile AP-profile1

end

To view the status of the added AP unit

config wireless-controller wtp
edit FAP22A3U10600118
get

The join-time field should show a time, not “N/A”. See the preceding web-based manager procedure for more
information.

Disable automatic discovery of unknown FortiAPs

By default, the FortiGate adds newly discovered FortiAPs to the Managed FortiAPs list, awaiting the
administrator's authorization. Optionally, you can disable this automatic registration function to avoid adding
unknown FortiAPs. A FortiAP will be registered and listed only if its serial number has already been added
manually to the Managed FortiAPs list. AP registration is configured on each interface.

To disable automatic discovery and registration, enter the following command:

config system interface
edit port15
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set ap-discover disable
end

Automatic authorization of extension devices

To simplify adding FortiAP or FortiSwitch devices to your network, you can enable automatic authorization of
devices as they are connected, instead of authorizing each one individually.

This feature is only configurable in the CLI.

To enable automatic authorization on all dedicated interfaces

config system global
set auto-auth-extension-device enable

end

To enable automatic authorization per-interface

config system interface
edit <port>

set auto-auth-extension-device enable
end

Assigning the same profile to multiple FortiAP units

The same profile can now be applied to multiple managed FortiAP units at the same time. To do this, do the
following:

1. Go toWiFi & Switch Controller > Managed FortiAPs to view the AP list.
2. Select all FortiAP units you wish to apply the profile to.
3. Right click on one of the selected FortiAPs and select Assign Profile.
4. Choose the profile you wish to apply.

Overriding the FortiAP Profile

In the FortiAP configurationWiFi & Switch Controller > Managed FortiAPs, there several radio settings
underOverride Radio 1 andOverride Radio 2 to choose a value independently of the FortiAP Profile setting.
When each of the radios are disabled, you will see what the FortiAP Profile has each of the settings configured to.

Band The available options depend on the capability of the radio. Overriding Band
also overridesChannels. Make appropriate settings in Channels.

Channels Choose channels. The available channels depend on the Band.

TX Power Control If you enable Auto, adjust to set the power range in dBm.
If you enableManual, adjust the slider. The 100% setting is the maximum power
permitted in your region. See Configuring a WiFi LAN on page 1414.

SSIDs
Select between Auto orManual. Selecting Auto eliminates the need to re-edit
the profile when new SSIDs are created. However, you can still select SSIDs
individually usingManual.
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To override radio settings in the CLI

In this example, Radio 1 is set to 802.11n on channel 11, regardless of the profile setting.

config wireless-controller wtp
edit FP221C3X14019926

config radio-1
set override-band enable
set band 802.11n
set override-channel enable
set channel 11

end

Override settings are available for band, channel, vaps (SSIDs), and txpower.

Outside of configuring radio settings, you can also override FortiAP LED state, WAN port mode, IP
Fragmentation prevention method, spectrum analysis, split tunneling, and login password settings.

Accessing the FortiAP CLI through the FortiGate unit

Enable remote login for the FortiAP. In the FortiAP Profile for this FortiAP, enable remote access.

Connecting to the FortiAP CLI

The FortiAP unit has a CLI through which some configuration options can be set. You can access the CLI using
Telnet.

To access the FortiAP unit CLI through the FortiAP Ethernet port

1. Connect your computer to the FortiAP Ethernet interface, either directly with a cross-over cable or through a
separate switch or hub.

2. Change your computer’s IP address to 192.168.1.3
3. Telnet to IP address 192.168.1.2.

Ensure that FortiAP is in a private network with no DHCP server for the static IP address to be accessible.
4. Login with user name admin and no password.
5. Enter commands as needed.
6. Optionally, use the passwd command to assign an administrative password for better security.
7. Save the configuration by entering the following command:

cfg –c .

8. Unplug the FortiAP and then plug it back in, in order for the configuration to take effect

Accessing the FortiAP CLI through the FortiGate

After the FortiAP has been installed, physical access to the unit might be inconvenient. You can access a
connected FortiAP unit's CLI through the FortiGate unit that controls it.

To enable remote access to the FortiAP CLI

In the CLI, edit the FortiAP Profile that applies to this FortiAP.

config wireless-controller wtp-profile
edit FAP221C-default

set allowaccess telnet
end
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FortiAP now supports HTTPS and SSH administrative access, as well as HTTP and
Telnet. Use the command above to set administrative access to telnet, http,
https, or ssh.

To access the FortiAP unit CLI through the FortiGate unit - GUI

1. Go toWiFi & Switch Controller > Managed FortiAPs.
2. In the list, right-click the FortiAP unit and select >_Connect to CLI.

A detached Console window opens.
3. At the FortiAP login prompt, enter admin. When you are finished using the FortiAP CLI, enter exit.

To access the FortiAP unit CLI through the FortiGate unit - CLI

1. Use the FortiGate CLI execute telnet command to access the FortiAP. For example, if the FortiAP unit IP
address is 192.168.1.2, enter:

execute telnet 192.168.1.2

2. At the FortiAP login prompt, enter admin. When you are finished using the FortiAP CLI, enter exit.

When a WiFi controller has taken control of the FortiAP unit, Telnet access to the
FortiAP unit’s CLI is no longer available.

Checking and updating FortiAP unit firmware

You can view and update the FortiAP unit’s firmware from the FortiGate unit that acts as its WiFi controller.

Checking the FortiAP unit firmware version

Go toWiFi & Switch Controller > Managed FortiAPs to view the list of FortiAP units that the FortiGate unit
can manage. TheOS Version column shows the current firmware version running on each AP.

Updating FortiAP firmware from the FortiGate unit

You can update the FortiAP firmware using either the web-based manager or the CLI. Only the CLI method can
update all FortiAP units at once.

To update FortiAP unit firmware - web-based manager

1. Go toWiFi & Switch Controller > Managed FortiAPs.
2. Right-click the FortiAP unit in the list and select Upgrade Firmware.

or
Edit the FortiAP entry and select Upgrade from File in FortiAP OS Version.

3. Select Browse and locate the firmware upgrade file.
4. Select OK.
5. When the upgrade process completes, select OK.

The FortiAP unit restarts.
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To update FortiAP unit firmware - CLI

1. Upload the FortiAP image to the FortiGate unit.
For example, the Firmware file is FAP_22A_v4.3.0_b0212_fortinet.out and the server IP address is
192.168.0.100.

execute wireless-controller upload-wtp-image tftp FAP_22A_v4.3.0_b0212_fortinet.out
192.168.0.100

If your server is FTP, change tftp to ftp, and if necessary add your user name and password at the
end of the command.

2. Verify that the image is uploaded:
execute wireless-controller list-wtp-image

3. Upgrade the FortiAP units:
exec wireless-controller reset-wtp all

If you want to upgrade only one FortiAP unit, enter its serial number instead of all.

Updating FortiAP firmware from the FortiAP unit

You can connect to a FortiAP unit’s internal CLI to update its firmware from a TFTP server on the same network.
This method does not require access to the wireless controller.

1. Place the FortiAP firmware image on a TFTP server on your computer.
2. Connect the FortiAP unit to a separate private switch or hub or directly connect to your computer via a cross-over

cable.
3. Change your computer’s IP address to 192.168.1.3.
4. Telnet to IP address 192.168.1.2.

This IP address is overwritten if the FortiAP is connected to a DHCP environment. Ensure that the FortiAP unit is
in a private network with no DHCP server.

5. Login with the username “admin” and no password.
6. Enter the following command.

For example, the FortiAP image file name is FAP_22A_v4.3.0_b0212_fortinet.out.
restore FAP_22A_v4.3.0_b0212_fortinet.out 192.168.1.3

Advanced WiFi controller discovery
A FortiAP unit can use any of six methods to locate a controller. By default, FortiAP units cycle through all six of
the discovery methods. In most cases there is no need to make configuration changes on the FortiAP unit.

There are exceptions. The following section describes the WiFi controller discovery methods in more detail and
provides information about configuration changes you might need to make so that discovery will work.

Controller discovery methods

There are six methods that a FortiAP unit can use to discover a WiFi controller. Below is the list of AC discovery
methods used in sequence, if the FortiAP's discovery type is set to auto:

1(static) → 2(dhcp) → 3(dns) → 7(forticloud) → 5(multicast) → 6(broadcast)

For every discovery type, FortiAP sends out discovery requests and sets a timer, an interval defined as a random
number of seconds (between 2-180, default is 5 seconds), which is set via the CLI:
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CLI syntax

config wireless-controller timers
set discovery-interval 5

end

After the timeout is reached, FortiAP sends out another discovery request, up to a maximum of 3 times.

After about 3 - 15 seconds, if FortiAP has no AC connection, it will switch to another discovery type and repeat the
above process until the last one (broadcast) fails, which will lead to SULKING state.

After about 30 seconds, FortiAP will go into an AC_IP_DISCVER state. After the AC IP is found, it will go to IDLE
state, and will eventually go to the DISCOVERY state, and repeat the above process again.

Note that, while the process above is showcasing the auto discovery method, it's recommended to set the AC_
DISCOVERY_TYPE to your used method in order to reduce downtime.

Static IP configuration

If FortiAP and the controller are not in the same subnet, broadcast and multicast packets cannot reach the
controller. The admin can specify the controller’s static IP on the AP unit. The AP unit sends a discovery request
message in unicast to the controller. Routing must be properly configured in both directions.

To specify the controller’s IP address on a FortiAP unit

cfg –a AC_IPADDR_1="192.168.0.100"

By default, the FortiAP unit receives its IP address, netmask, and gateway address by DHCP. If you prefer, you
can assign these statically.

To assign a static IP address to the FortiAP unit

cfg -a ADDR_MODE=STATIC
cfg –a AP_IPADDR="192.168.0.100"
cfg -a AP_NETMASK="255.255.255.0"
cfg –a IPGW=192.168.0.1
cfg -c

For information about connecting to the FortiAP CLI, see Connecting to the FortiAP CLI on page 1444.

DHCP

If you use DHCP to assign an IP address to your FortiAP unit, you can also provide the WiFi controller IP address
at the same time. This is useful if the AP is located remotely from the WiFi controller and other discovery
techniques will not work.

When you configure the DHCP server, configure Option 138 to specify the WiFi controller IP address. You need to
convert the address into hexadecimal. Convert each octet value separately from left to right and concatenate
them. For example, 192.168.0.1 converts to C0A80001.

If Option 138 is used for some other purpose on your network, you can use a different option number if you
configure the AP units to match.

To change the FortiAP DHCP option code

To use option code 139 for example, enter

cfg –a AC_DISCOVERY_DHCP_OPTION_CODE=139
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For information about connecting to the FortiAP CLI, see Connecting to the FortiAP CLI on page 1444.

DNS

The access point can discover controllers through your domain name server (DNS). For the access point to do so,
you must configure your DNS to return controller IP addresses in response. Allow DNS lookup of the hostname
configured in the AP by using the AP parameter "AC_HOSTNAME_1".

FortiCloud

The access point can discover FortiCloud by doing a DNS lookup of the hardcoded FortiCloud AP controller
hostname "apctrl1.fortinet.com". The forticloud AC discovery technique finds the AC info from apctl1.fortinet.com
using HTTPS.

FortiCloud APController: apctrl1.fortinet.com:443 208.91.113.187:443

Broadcast request

The AP unit broadcasts a discovery request message to the network and the controller replies. The AP and the
controller must be in the same broadcast domain. No configuration adjustments are required.

Multicast request

The AP unit sends a multicast discovery request and the controller replies with a unicast discovery response
message. The AP and the controller do not need to be in the same broadcast domain if multicast routing is
properly configured.

The default multicast destination address is 224.0.1.140. It can be changed through the CLI. The address must
be same on the controller and AP.

To change the multicast address on the controller

config wireless-controller global
set discovery-mc-addr 224.0.1.250

end

To change the multicast address on a FortiAP unit

cfg –a AC_DISCOVERY_MC_ADDR="224.0.1.250"

For information about connecting to the FortiAP CLI, see Advanced WiFi controller discovery on page 1446.

Wireless client load balancing for high-density deployments
Wireless load balancing allows your wireless network to distribute wireless traffic more efficiently among wireless
access points and available frequency bands. FortiGate wireless controllers support the following types of client
load balancing:

l Access Point Hand-off - the wireless controller signals a client to switch to another access point.
l Frequency Hand-off - the wireless controller monitors the usage of 2.4GHz and 5GHz bands, and signals clients to

switch to the lesser-used frequency.

Load balancing is not applied to roaming clients.
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Access point hand-off

Access point handoff wireless load balancing involves the following:

l If the load on an access point (ap1) exceeds a threshold (of for example, 30 clients) then the client with the weakest
signal will be signaled by wireless controller to drop off and join another nearby access point (ap2).

l When one or more access points are overloaded (for example, more than 30 clients) and a new client attempts to
join a wireless network, the wireless controller selects the least busy access point that is closest to the new client
and this access point is the one that responds to the client and the one that the client joins.

Frequency hand-off or band-steering

Encouraging clients to use the 5GHzWiFi band if possible enables those clients to benefit from faster
interference-free 5GHz communication. The remaining 2.4GHz clients benefit from reduced interference.

The WiFi controller probes clients to determine their WiFi band capability. It also records the RSSI (signal
strength) for each client on each band.

If a new client attempts to join the network, the controller looks up that client’s MAC address in its wireless device
table and determines if it’s a dual band device. If it is not a dual band device, then its allowed to join. If it is a dual
band device, then its RSSI on 5GHz is used to determine whether the device is close enough to an access point
to benefit from movement to 5GHz frequency.

If both conditions of 1) dual band device and 2) RSSI value is strong, then the wireless controller does not reply to
the join request of the client. This forces the client to retry a few more times and then timeout and attempt to join
the same SSID on 5GHz. Once the Controller see this new request on 5GHz, the RSSI is again measured and the
client is allowed to join. If the RSSI is below threshold, then the device table is updated and the controller forces
the client to timeout again. A client’s second attempt to connect on 2.4GHz will be accepted.

Configuration

From the web-based manager, edit a custom AP profile and select Frequency Handoff and AP Handoff as
required for each radio on the AP.

From the CLI, you configure wireless client load balancing thresholds for each custom AP profile. Enable access
point hand-off and frequency hand-off separately for each radio in the custom AP profile.

config wireless-controller wtp-profile
edit new-ap-profile

set handoff-rssi <rssi_int>
set handoff-sta-thresh <clients_int>
config radio-1

set frequency-handoff {disable | enable}
set ap-handoff {disable | enable}

end
config radio-2

set frequency-handoff {disable | enable}
set ap-handoff {disable | enable}

end
end

Where:

l handoff-rssi is the RSSI threshold. Clients with a 5 GHz RSSI threshold over this value are load balanced to
the 5GHz frequency band. Default is 25. Range is 20 to 30.
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l handoff-sta-thresh is the access point handoff threshold. If the access point has more clients than this
threshold it is considered busy and clients are changed to another access point. Default is 30, range is 5 to 25.

l frequency-handoff enable or disable frequency handoff load balancing for this radio. Disabled by default.
l ap-handoff enable or disable access point handoff load balancing for this radio. Disabled by default.

Frequency handoff must be enabled on the 5GHz radio to learn client capability.

FortiAP Groups
FortiAPGroups facilitate the application of FortiAP profiles to large numbers of FortiAPs. A FortiAP can belong to
no more than one FortiAPGroup. A FortiAPGroup can include only one model of FortiAP.

Through the VLAN pool feature, a FortiAPGroup can be associated with a VLAN to which WiFi clients will be
assigned. For more on VLAN pool assignment, see VLAN assignment by VLAN pool.

FortiAP groups are only configurable in the CLI Console.

To create a FortiAP group - CLI

In this example, wtp-group-1 is created for a FortiAP-221C and one member device is added.

config wireless-controller wtp-group
edit wtp-group-1

set platform-type 221C
config wtp-list

edit FP221C3X14019926
end

end

LAN port options
Some FortiAPmodels have one or more LAN interfaces that can provide wired network access. LAN ports can be

l bridged to the incoming WAN interface
l bridged to one of the WiFi SSIDs that the FortiAP unit carries
l connected by NAT to the incoming WAN interface

There are some differences among FortiAPmodels.

Models like 11C and 14C have one port labeled WAN and one or more ports labeled LAN. By default, the LAN
ports are offline. You can configure LAN port operation in the FortiAP Profile in the GUI (Wireless Controller >
FortiAP Profiles) or in the CLI (config wireless-controller wtp-profile, config lan
subcommand).

Models like 320C, 320B, 112D, and 112B have two ports, labeled LAN1 and LAN2. LAN1 acts as a WAN port
connecting the FortiAP to a FortiGate or FortiCloud. By default, LAN2 is bridged to LAN1. Other modes of LAN2
operation must be enabled in the CLI:

config wireless-controller wtp-profile
edit <profile_name>

set wan-port-mode wan-lan
end

By default wan-port-mode is set to wan-only.
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When wan-port-mode is set to wan-lan, LAN2 Port options are available in the GUI and the CLI the same as
the other FortiAPmodels that have labeled WAN and LAN ports.

Bridging a LAN port with an SSID

Bridging a LAN port with a FortiAP SSID combines traffic from both sources to provide a single broadcast domain
for wired and wireless users.

In this configuration

l The IP addresses for LAN clients come from the DHCP server that serves the wireless clients.
l Traffic from LAN clients is bridged to the SSID’s VLAN. Dynamic VLAN assignment for hosts on the LAN port is not

supported.
l Wireless and LAN clients are on the same network and can communicate locally, via the FortiAP.
l Any host connected to the LAN port will be taken as authenticated. RADIUSMAC authentication for hosts on the

LAN port is not supported.

For configuration instructions, see LAN port options on page 1450.

Bridging a LAN port with the WAN port

Bridging a LAN port with the WAN port enables the FortiAP unit to be used as a hub which is also an access point.

In this configuration

l The IP addresses for LAN clients come from the WAN directly and will typically be in the same range as the AP
itself.

l All LAN client traffic is bridged directly to the WAN interface.
l Communication between wireless and LAN clients can only occur if a policy on the FortiGate unit allows it.

For configuration instructions, see LAN port options on page 1450.

Configuring FortiAP LAN ports

You can configure FortiAP LAN ports for APs in a FortiAP Profile. A profile applies to APs that are the same model
and share the same configuration. If you have multiple models or different configurations, you might need to
create several FortiAP Profiles. For an individual AP, it is also possible to override the profile settings.

To configure FortiAP LAN ports - web-based manager

1. If your FortiAP unit has LAN ports, but no port labeled WAN (models 320C, 320B, 112D, and 112B for example),
enable LAN port options in the CLI:
config wireless-controller wtp-profile

edit <profile_name>
set wan-port-mode wan-lan

end

2. Go toWiFi & Switch Controller > FortiAP Profiles.
3. Edit the default profile for your FortiAPmodel or select Create New.
4. If you are creating a new profile, enter a Name and select the correct Platform (model).
5. Select SSIDs.
6. In the LAN Port section, set Mode to Bridge to and select an SSID orWAN Port as needed.

On some models with multiple LAN ports, you can set Mode to Custom and configure the LAN ports individually.
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Enable each port that you want to use and select an SSID orWAN Port as needed.
7. Select OK.
Be sure to select this profile when you authorize your FortiAP units.

To configure FortiAP LAN ports - CLI

In this example, the default FortiAP-11C profile is configured to bridge the LAN port to the office SSID.

config wireless-controller wtp-profile
edit FAP11C-default

config lan
set port-mode bridge-to-ssid
set port-ssid office

end
end

end

In this example, the default FortiAP-28C profile is configured to bridge LAN port1 to the office SSID and to bridge
the other LAN ports to the WAN port.

config wireless-controller wtp-profile
edit FAP28C-default

config lan
set port1-mode bridge-to-ssid
set port1-ssid office
set port2-mode bridge-to-wan
set port3-mode bridge-to-wan
set port4-mode bridge-to-wan
set port5-mode bridge-to-wan
set port6-mode bridge-to-wan
set port7-mode bridge-to-wan
set port8-mode bridge-to-wan

end
end

In this example, the default FortiAP-320C profile is configured to bridge the LAN port to the office SSID.

config wireless-controller wtp-profile
edit FAP320C-default

set wan-port-mode wan-lan
config lan

set port-mode bridge-to-ssid
set port-ssid office

end
end

end

To configure FortiAP unit LAN ports as a FortiAP Profile override - web-based manager

1. Go toWiFi & Switch Controller > Managed FortiAPs.
2. Select the FortiAP unit from the list and select Edit.
3. Select the FortiAP Profile, if this has not already been done.
4. In the LAN Port section, select Override.

The options forMode are shown.
5. Set Mode to Bridge to and select an SSID orWAN Port, orNAT to WAN as needed.

On some models with multiple LAN ports, you can set Mode to Custom and configure the LAN ports individually.
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Enable and configure each port that you want to use.
6. Select OK.

To configure FortiAP unit LAN ports as a FortiAP Profile override - CLI

In this example, a FortiAP unit’s configuration overrides the FortiAP Profile to bridge the LAN port to the office
SSID.

config wireless-controller wtp
edit FP320C3X14020000

set wtp-profile FAP320C-default
set override-wan-port-mode enable
set wan-port-mode wan-lan
set override-lan enable
config lan

set port-mode bridge-to-ssid
set port-ssid office

end
end

Preventing IP fragmentation of packets in CAPWAP tunnels
A common problem with controller-based WiFi networks is reduced performance due to IP fragmentation of the
packets in the CAPWAP tunnel.

Fragmentation can occur because of CAPWAP tunnel overhead increasing packet size. If the original wireless
client packets are close to the maximum transmission unit (MTU) size for the network (usually 1500 bytes for
Ethernet networks unless jumbo frames are used) the resulting CAPWAP packets may be larger than the MTU,
causing the packets to be fragmented. Fragmenting packets can result in data loss, jitter, and decreased
throughput.

The FortiOS/FortiAP solution to this problem is to cause wireless clients to send smaller packets to FortiAP
devices, resulting in1500-byte CAPWAP packets and no fragmentation. The following options configure CAPWAP
IP fragmentation control:

config wireless-controller wtp-profle
edit FAP321C-default

set ip-fragment-preventing {tcp-mss-adjust | icmp-unreachable}
set tun-mtu-uplink {0 | 576 | 1500}
set tun-mtu-downlink {0 | 576 | 1500}

end
end

By default, tcp-mss-adjust is enabled, icmp-unreachable is disabled, and tun-mtu-uplink and
tun-mtu-downlink are set to 0.

To set tun-mtu-uplink and tun-mtu-downlink, use the default TCPMTU value of 1500. This default
configuration prevents packet fragmentation because the FortiAP unit limits the size of TCP packets received
from wireless clients so the packets don’t have to be fragmented before CAPWAP encapsulation.

The tcp-mss-adjust option causes the FortiAP unit to limit the maximum segment size (MSS) of TCP
packets sent by wireless clients. The FortiAP does this by adding a reduced MSS value to the SYN packets sent
by the FortiAP unit when negotiating with a wireless client to establish a session. This results in the wireless client
sending packets that are smaller than the tun-mtu-uplink setting, so that when the CAPWAP headers are
added, the CAPWAP packets have an MTU that matches the tun-mtu-uplink size.
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The icmp-unreachable option affects all traffic (UDP and TCP) between wireless clients and the FortiAP unit.
This option causes the FortiAP unit to drop packets that have the "Don't Fragment" bit set in their IP header and
that are large enough to cause fragmentation and then send an ICMP packet -- type 3 "ICMPDestination
unreachable" with code 4 "Fragmentation Needed and Don't Fragment was Set" back to the wireless controller.
This should cause the wireless client to send smaller TCP and UDP packets.

Overriding IP fragmentation settings on a FortiAP

If the FortiAP Profile settings for IP fragmentation are not appropriate for a particular FortiAP, you can override
the settings on that specific unit.

config wireless-controller wtp
edit FAP321C3X14019926

set override-ip-fragment enable
set ip-fragment-preventing {tcp-mss-adjust | icmp-unreachable}
set tun-mtu-uplink {0 | 576 | 1500}
set tun-mtu-downlink {0 | 576 | 1500}

end
end

LED options
Optionally, the status LEDs on the FortiAP can be kept dark. This is useful in dormitories, classrooms, hotels,
medical clinics, hospitals where the lights might be distracting or annoying to occupants.

On the FortiGate, the LED state is controlled in the FortiAP Profile. By default the LEDs are enabled. The setting
is CLI-only. For example, to disable the LEDs on FortiAP-221C units controlled by the FAP221C-default profile,
enter:

config wireless-controller wtp-profile
edit FAP221C-default

set led-state disable
end

You can override the FortiAP Profile LED state setting on an individual FortiAP using the CLI. For example, to
make sure the LEDs are disabled on one specific unit, enter:

config wireless-controller wtp
edit FAP221C3X14019926

set override-led-state enable
set led-state disable

end

The LED state is also controllable from the FortiAP unit itself. By default, the FortiAP follows the FortiAP Profile
setting.

LED Schedules

Use the command below (led-schedule) to assign recurring firewall schedules for illuminating LEDs on the
FortiAP. This entry is only available when led-state is enabled, at which point LEDs will be visible when at
least one of the schedules is valid.

Separate multiple schedule names with a space, as configured under config firewall schedule group
and config firewall schedule recurring.
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Syntax

config wireless-controller wtp-profile
edit {name}

set led-state {enable | disable}
set led-schedules <name>

next
end

CAPWAP bandwidth formula
The following section provides information on how to calculate the control plane CAPWAP traffic load in local
bridging. The formula provided can help estimate the approximate package bandwidth cost. This is important for
knowing precisely how much bandwidth is required on a WAN link for a centralized ForitGate managing hundreds
of access points.

There are multiple factors that might affect the volume of CAPWAP control traffic, including the number of
stations there are and large WiFi events.

The Ethernet/IP/UDP/CAPWAP uplink header cost should be approximately 66 bytes.

The tables below depict basic and commonly used optional CAPWAP bandwidth costs, on a per-AP basis.

Note the following:

l STA: The number of stations associated with the FortiAP.
l ARP scan: Finds hidden devices in your network.
l VAP: The number of VAPS held by the FortiAP.
l Radio: The number of radios (maximum of two) enabled by the FortiAP.

Basic per-AP CAPWAP bandwidth costs

Content Time
(seconds)

Payload
(byte) Package bandwidth cost (bps)

Echo Req 30 16 (66+16)*8/30=21.86

STA scan 30 25+20*sta (66+25+20*sta)*8/30=24.26+5.3*sta

ARP scan 30 25+18*sta (66+25+18*sta)*8/30=24.26+4.8*sta

STACAP 30 25+19*sta (66+25+19*sta)*8/30=24.26+5.1*sta

STA stats 1 25+41*sta (66+25+41*sta)*8/1=728.0+328.0*sta

VAP stats 15 40+18*vap (66+40+18*vap)*8/15=56.53+9.6*vap

Radio stats 15 25+25*radio (66+25+25*radio)*8/15=48.53+13.3*radio

Total: 908.7+343.2*sta+9.6*vap+13.3*radio
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Commonly used optional per-AP CAPWAP bandwidth costs

Content Time
(seconds) Payload (byte) Package bandwidth cost (bps)

AP scan 30 25+63*scanned-
ap

(66+25+63*scanned-ap)*8/30=24.26+16.8*scanned-ap

Total: 932.96+343.2*sta+9.6*vap+13.3*radio+16.8*scanned-
ap

Enabling WIDS features, LLDP, MESH, FortiPresence, and Client Station Locating
Service can lead to additional bandwidth consumption.

Example:

There are 100 FortiAPs, with 187 stations distributed among them. Each FortiAP holds five VAPs among their
radios, and each enables two radios. The basic CAPWAP bandwidth cost would be:

908.7*100+343.2*187+9.6*5*100+13.3*2*100 = 162.51kbps

Additionally, if two FortiAPs enabled "AP scan", and suppose one scans 99 APs in each scan and the other scans
20 APs in each scan, the additional CAPWAP bandwidth cost would be:

(24.26+16.8*99)+(24.26+16.8*20) = 2 kbps

Enabling LLDP protocol

You can enable the LLDP protocol in the FortiAP Profile via the CLI. Each FortiAP using that profile can then send
back information about the switch and port that it is connected to.

To enable LLDP, enter the following:

config wireless-controller wtp-profile
edit <profile-name>

set lldp enable
end
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The access points of a WiFi network are usually connected to the WiFi controller through Ethernet wiring. A
wireless mesh eliminates the need for Ethernet wiring by connecting WiFi access points to the controller by radio.
This is useful where installation of Ethernet wiring is impractical.

Overview of Wireless Mesh
The figure below shows a wireless mesh topology.

A wireless mesh is a multiple AP network in which only one FortiAP unit is connected to the wired network. The
other FortiAPs communicate with the controller over a separate backhaul SSID that is not available to regular
WiFi clients. The AP that is connected to the network by Ethernet is called the Mesh Root node. The backhaul
SSID carries CAPWAP discovery, configuration, and other communications that would usually be carried on an
Ethernet connection.

The root node can be a FortiAP unit or the built-in AP of a FortiWiFi unit. APs that serve regular WiFi clients are
called Leaf nodes. Leaf APs also carry the mesh SSID for more distant leaf nodes. A leaf node can connect to the
mesh SSID directly from the root node or from any of the other leaf nodes. This provides redundancy in case of an
AP failure.

All access points in a wireless mesh configuration must have at least one of their radios configured to provide
mesh backhaul communication. As with wired APs, when mesh APs start up they can be discovered by a
FortiGate or FortiWiFi unit WiFi controller and authorized to join the network.

The backhaul SSID delivers the best performance when it is carried on a dedicated radio. On a two-radio FortiAP
unit, for example, the 5GHz radio could carry only the backhaul SSID while the 2.4GHz radio carries one or more
SSIDs that serve users. Background WiFi scanning is possible in this mode.

The backhaul SSID can also share the same radio with SSIDs that serve users. Performance is reduced because
the backhaul and user traffic compete for the available bandwidth. Background WiFi scanning is not available in
this mode. One advantage of this mode is that a two-radio AP can offer WiFi coverage on both bands.
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Wireless mesh deployment modes

There are two common wireless mesh deployment modes:

Wireless Mesh Access points are wirelessly connected to a FortiGate or FortiWiFi unit WiFi controller.
WiFi users connect to wireless SSIDs in the same way as on non-mesh WiFi networks.

Wireless
bridging

Two LAN segments are connected together over a wireless link (the backhaul SSID).
On the leaf AP, the Ethernet connection can be used to provide a wired network. Both
WiFi and wired users on the leaf AP are connected to the LAN segment to which the
root AP is connected.

Firmware requirements

All FortiAP units that will be part of the wireless mesh network must be upgraded to FAP firmware version 5.0
build 003. FortiAP-222B units must have their BIOS upgraded to version 400012. The FortiWiFi or FortiGate unit
used as the WiFi controller must be running FortiOS 5.0.

Types of wireless mesh

AWiFi mesh can provide access to widely-distributed clients. The root mesh APwhich is directly connected to the
WiFi controller can be either a FortiAP unit or the built-in AP of a FortiWiFi unit that is also the WiFi controller.

FortiAP units used as both mesh root AP and leaf AP

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1458



Wireless Mesh

FortiWiFi unit as root mesh AP with FortiAP units as leaf APs

An alternate use of the wireless mesh functionality is as a point-to-point relay. Both wired and WiFi users on the
leaf AP side are connected to the LAN segment on the root mesh side.
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Point-to-point wireless mesh
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Fast-roaming for mesh backhaul link

Mesh implementations for leaf FortiAP can perform background scan when the leaf AP is associated to root.
Various options for background scanning can be configured with the CLI. See Mesh variables on page 1562 for
more details.

Configuring a meshed WiFi network
You need to:

l Create the mesh root SSID.
l Create the FortiAP profile.
l Configure mesh leaf AP units.
l Configure the mesh root AP, either a FortiWiFi unit’s Local Radio or a FortiAP unit.
l Authorize the mesh branch/leaf units when they connect to the WiFi Controller.
l Create security policies.

This section assumes that the end-user SSIDs already exist.

Creating the mesh root SSID

The mesh route SSID is the radio backhaul that conveys the user SSID traffic to the leaf FortiAPs.

To configure the mesh root SSID

1. Go toWiFi & Switch Controller > SSID and select Create New > SSID.
2. Enter a Name for the WiFi interface.
3. In Traffic Mode, select Mesh Downlink.
4. Enter the SSID.
5. Set Security Mode toWPA2 Personal and enter the Pre-shared key.

Remember the key, you need to enter it into the configurations of the leaf FortiAPs.
6. Select OK.

Creating the FortiAP profile

Create a FortiAP profile for the meshed FortiAPs. If more than one FortiAPmodel is involved, you need to create
a profile for each model. Typically, the profile is configured so that Radio 1 (5GHz) carries the mesh backhaul
SSID while Radio 2 (2.4GHz) carries the SSIDs to which users connect.

The radio that carries the backhaul traffic must not carry other SSIDs. Use the Select SSIDs option and choose
only the backhaul SSID. Similarly, the radio that carries user SSIDs, should not carry the backhaul. Use the Select
SSIDs option and choose the networks that you want to provide.

For more information, see Configuring a WiFi LAN on page 1414.

Configuring the mesh root FortiAP

The mesh root AP can be either a FortiWiFi unit’s built-in AP or a FortiAP unit.
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To enable a FortiWiFi unit’s Local Radio as mesh root - web-based manager

1. Go toWiFi Controller > Local WiFi Radio.
2. Select Enable WiFi Radio.
3. In SSID, select Select SSIDs, then select the mesh root SSID.
4. Optionally, adjust TX Power or select Auto Tx Power Control.
5. Select Apply.

In a network with multiple wireless controllers, make sure that each mesh root has a
unique SSID. Other controllers using the same mesh root SSID might be detected as
fake or rogue APs. Go toWiFi & Switch Controller > SSID to change the SSID.

To configure a network interface for the mesh root FortiAP unit

1. On the FortiGate unit, go to Network > Interfaces.
2. Select the interface where you will connect the FortiAP unit, and edit it.
3. Make sure that Role is LAN.
4. In Addressing mode, select Dedicated to Extension Device.
5. In IP/Network Mask, enter an IP address and netmask for the interface.

DHCPwill provide addresses to connected devices. To maximize the number of available addresses, the interface
address should end with 1, for example 192.168.10.1.

6. Select OK.
At this point you can connect the mesh root FortiAP, as described next. If you are going to configure leaf FortiAPs
through the wireless controller (see "Configuring a meshed WiFi network" on page 1462), it would be convenient
to leave connecting the root unit for later.

To enable the root FortiAP unit

1. Connect the root FortiAP unit’s Ethernet port to the FortiGate network interface that you configured for it.
2. Go toWiFi & Switch Controller > Managed FortiAPs.

If the root FortiAP unit is not listed, wait 15 seconds and select Refresh. Repeat if necessary. If the unit is
still missing after a minute or two, power cycle the root FortiAP unit and try again.

3. Right-click the FortiAP entry and choose your profile from the Assign Profile submenu.
4. Right-click the FortiAP entry and select Authorize.

Initially, the State of the FortiAP unit isOffline. Periodically clickRefresh to update the status. Within about
two minutes, the state changes toOnline.

5. Select OK.
You might need to select Refresh a few times before the FortiAP shows as Online.

Configuring the leaf mesh FortiAPs

The FortiAP units that will serve as leaf nodes must be preconfigured. This involves changing the FortiAP unit
internal configuration.You can do this by direct connection or through the FortiGate wireless controller.
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Method 1: Direct connection to the FortiAP

1. Connect a computer to the FortiAP unit's Ethernet port. Configure the computer's IP as 192.168.1.3.
2. Telnet to 192.168.1.2. Login as admin. By default, no password is set.
3. Enter the following commands, substituting your own SSID and password (pre-shared key):

cfg -a MESH_AP_TYPE=1
cfg -a MESH_AP_SSID=fortinet.mesh.root
cfg -a MESH_AP_PASSWD=hardtoguess
cfg -c
exit

4. Disconnect the computer.
5. Power down the FortiAP.
6. Repeat the preceding steps for each branch FortiAP.

Method 2: Connecting through the FortiGate unit

1. Connect the branch FortiAP unit’s Ethernet port to the FortiGate network interface that you configured for
FortiAPs. Connect the FortiAP unit to a power source unless POE is used.

2. Go toWiFi & Switch Controller > Managed FortiAPs.
If the FortiAP unit is not listed, wait 15 seconds and select Refresh. Repeat if necessary. If the unit is still missing
after a minute or two, power cycle the FortiAP unit and try again.

3. Select the discovered FortiAP unit and authorize it. Click Refresh every 10 seconds until the State indicator is
green.

4. Right-click the FortiAP and select >_Connect to CLI. The CLI Console window opens. Log in as "admin".
5. Enter the following commands, substituting your own SSID and password (pre-shared key):

cfg -a MESH_AP_TYPE=1
cfg -a MESH_AP_SSID=fortinet.mesh.root
cfg -a MESH_AP_PASSWD=hardtoguess
cfg -c
exit

6. Disconnect the branch FortiAP and delete it from the Managed FortiAP list.
7. Repeat the preceding steps for each branch FortiAP.

Authorizing leaf APs

When the root FortiAP is connected and online, apply power to the pre-configured leaf FortiAPs. The leaf
FortiAPs will connect themselves wirelessly to the WiFi Controller through the mesh network. You must authorize
each unit.

1. Go toWiFi & Switch Controller > Managed FortiAPs. Periodically select Refresh until the FortiAP unit is
listed. This can take up to three minutes.
The State of the FortiAP unit should beWaiting for Authorization.

2. Right-click the FortiAP entry and choose your profile from the Assign Profile submenu.
3. Right-click the FortiAP entry and select Authorize.

Initially, the State of the FortiAP unit isOffline. Periodically clickRefresh to update the status. Within about
two minutes, the state changes toOnline.
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Creating security policies

You need to create security policies to permit traffic to flow from the end-user WiFi network to the network
interfaces for the Internet and other networks. Enable NAT.

Viewing the status of the mesh network

Go toWiFi & Switch Controller > Managed FortiAPs to view the list of APs.

The Connected Via field lists the IP address of each FortiAP and uses icons to show whether the FortiAP is
connected by Ethernet or Mesh.

Ethernet

Mesh

If you mouse over the Connected Via information, a topology displays, showing how the FortiGate wireless
controller connects to the FortiAP.

Configuring a point-to-point bridge
You can create a point-to-point bridge to connect two wired network segments using a WiFi link. The effect is the
same as connecting the two network segments to the same wired switch.

You need to:

l Configure a backhaul link and root mesh AP as described in Configuring a point-to-point bridge on page 1464.
Note: The root mesh AP for a point-to-point bridge must be a FortiAP unit, not the internal AP of a FortiWiFi unit.

l Configure bridging on the leaf AP unit.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1464



Hotspot 2.0

To configure the leaf AP unit for bridged operation - FortiAP web-based manager

1. With your browser, connect to the FortiAP unit web-based manager.
You can temporarily connect to the unit’s Ethernet port and use its default address: 192.168.1.2.

2. Enter:

Operation Mode Mesh

Mesh AP SSID fortinet-ap

Mesh AP Password fortinet

Ethernet Bridge Select

3. Select Apply.
4. Connect the local wired network to the Ethernet port on the FortiAP unit.

Users are assigned IP addresses from the DHCP server on the wired network connected to the root mesh AP unit.

To configure a FortiAP unit as a leaf AP - FortiAP CLI

cfg -a MESH_AP_SSID=fortinet-ap
cfg -a MESH_AP_PASSWD=fortinet
cfg -a MESH_ETH_BRIDGE=1
cfg -a MESH_AP_TYPE=1
cfg -c

Hotspot 2.0

Hotspot 2.0 Access Network Query Protocol (ANQP) is a query and response protocol that defines seamless
roaming services offered by an AP. The following CLI commands are available under config wireless-
controller, to configure Hotspot 2.0 ANQP.

Syntax

config wireless-controller hotspot20 anqp-3gpp-cellular
edit {name}

config mcc-mnc-list
edit {id}

set id {integer}
set mcc {string}
set mnc {string}

next
next

end

config wireless-controller hotspot20 anqp-ip-address-type
edit {name}

set ipv6-address-type {option}
set ipv4-address-type {option}

next
end

config wireless-controller hotspot20 anqp-nai-realm
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edit {name}
config nai-list

edit {name}
set encoding {enable | disable}
set nai-realm {string}
config eap-method

edit {index}
set index {integer}
set method {option}
config auth-param

edit {index}
set index {integer}
set id {option}
set val {option}

next
next

next
next

end

config wireless-controller hotspot20 anqp-network-auth-type
edit {name}

set auth-type {option}
set url {string}

next
end

config wireless-controller hotspot20 anqp-roaming-consortium
edit {name}

config oi-list
edit {index}

set index {integer}
set oi {string}
set comment {string}

next
next

end

config wireless-controller hotspot20 anqp-venue-name
edit {name}

config value-list
edit {index}

set index {integer}
set lang {string}
set value {string}

next
next

end

config wireless-controller hotspot20 h2qp-conn-capability
edit {name}

set icmp-port {option}
set ftp-port {option}
set ssh-port {option}
set http-port {option}
set tls-port {option}
set pptp-vpn-port {option}

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1466



Hotspot 2.0

set voip-tcp-port {option}
set voip-udp-port {option}
set ikev2-port {option}
set ikev2-xx-port {option}
set esp-port {option}

next
end

config wireless-controller hotspot20 h2qp-operator-name
edit {name}

config value-list
edit {index}

set index {integer}
set lang {string}
set value {string}

next
next

end

config wireless-controller hotspot20 h2qp-osu-provider
edit {name}

config friendly-name
edit {index}

set index {integer}
set lang {string}
set friendly-name {string}

next
set server-uri {string}
set osu-method {option}
set osu-nai {string}
config service-description

edit {service-id}
set service-id {integer}
set lang {string}
set service-description {string}

next
set icon {string}

next
end

config wireless-controller hotspot20 h2qp-wan-metric
edit {name}

set link-status {option}
set symmetric-wan-link {option}
set link-at-capacity {enable | disable}
set uplink-speed {integer}
set downlink-speed {integer}
set uplink-load {integer}
set downlink-load {integer}
set load-measurement-duration {integer}

next
end

config wireless-controller hotspot20 hs-profile
edit {name}

set access-network-type {option}
set access-network-internet {enable | disable}
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set access-network-asra {enable | disable}
set access-network-esr {enable | disable}
set access-network-uesa {enable | disable}
set venue-group {option}
set venue-type {option}
set hessid {mac address}
set proxy-arp {enable | disable}
set l2tif {enable | disable}
set pame-bi {enable | disable}
set anqp-domain-id {integer}
set domain-name {string}
set osu-ssid {string}
set gas-comeback-delay {integer}
set gas-fragmentation-limit {integer}
set dgaf {enable | disable}
set deauth-request-timeout {integer}
set wnm-sleep-mode {enable | disable}
set bss-transition {enable | disable}
set venue-name {string}
set roaming-consortium {string}
set nai-realm {string}
set oper-friendly-name {string}
config osu-provider

edit {name}
next

set wan-metrics {string}
set network-auth {string}
set 3gpp-plmn {string}
set conn-cap {string}
set qos-map {string}
set ip-addr-type {string}

next
end

config wireless-controller hotspot20 icon
edit {name}

config icon-list
edit {name}

set lang {string}
set file {string}
set type {option}
set width {integer}
set height {integer}

next
next

end

config wireless-controller hotspot20 qos-map
edit {name}

config dscp-except
edit {index}

set index
set dscp
set up

next
config dscp-range

edit {index}

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1468



Hotspot 2.0

set index
set up
set low
set high

next
next

end

1469 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Combining WiFi and wired networks with a software switch

Combining WiFi and wired networks with a software switch
AWiFi network can be combined with a wired LAN so that WiFi and wired clients are on the same subnet. This is
a convenient configuration for users. Note that software switches are only available if your FortiGate is in
Interface mode.

Wireless Mesh features cannot be used in conjunction with this configuration because
they enable the FortiAP Local Bridge option.

To create the WiFi and wired LAN configuration, you need to:

l Configure the SSID so that traffic is tunneled to the WiFi controller.
l Configure a software switch interface on the FortiGate unit with the WiFi and internal network interface as

members.
l Configure Captive Portal security for the software switch interface.

To configure the SSID - web-based manager

1. Go toWiFi & Switch Controller > SSID and select Create New.
2. Enter:

Interface name A name for the newWiFi interface, homenet_if for example.

Traffic Mode Tunnel to Wireless Controller

SSID The SSID visible to users, homenet for example.

Security Mode
Data Encryption
Preshared Key

Configure security as you would for a regular WiFi network.

3. Select OK.
4. Go toWiFi & Switch Controller > Managed FortiAPs, select the FortiAP unit for editing.
5. Authorize the FortiAP unit.

The FortiAP unit can carry regular SSIDs in addition to the Bridge SSID.

To configure the SSID - CLI

This example creates a WiFi interface “homenet_if” with SSID “homenet” using WPA-Personal security,
passphrase “Fortinet1”.

config wireless-controller vap
edit "homenet_if"

set vdom "root"
set ssid "homenet"
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set security wpa-personal
set passphrase "Fortinet1"

end
config wireless-controller wtp

edit FAP22B3U11005354
set admin enable
set vaps "homenet_if"

end

To configure the FortiGate software switch - web-based manager

1. Go to Network > Interfaces and select Create New > Interface.
2. Enter:

Interface Name A name for the new interface, homenet_nw for example.

Type Software Switch

Physical Interface Members Add homenet_if and the internal network interface.

Addressing mode Select Manual and enter an address, for example
172.16.96.32/255.255.255.0

DHCP Server Enable and configure an address range for clients.

Security Mode Select Captive Portal. Add the permitted User Groups.

3. Select OK.

To configure the FortiGate unit - CLI

config system interface
edit homenet_nw

set ip 172.16.96.32 255.255.255.0
set type switch
set security-mode captive-portal
set security-groups "Guest-group"

end
config system interface

edit homenet_nw
set member "homenet_if" "internal"

end

VLAN configuration

If your environment uses VLAN tagging, you assign the SSID to a specific VLAN in the CLI. For example, to
assign the homenet_if interface to VLAN 100, enter:

config wireless-controller vap
edit "homenet_if"

set vlanid 100
end
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Additional configuration

The configuration described above provides communication between WiFi and wired LAN users only. To provide
access to other networks, create appropriate firewall policies between the software switch and other interfaces.

FortiAP local bridging (Private Cloud-Managed AP)
A FortiAP unit can provide WiFi access to a LAN, even when the wireless controller is located remotely. This
configuration is useful for the following situations:

l Installations where the WiFI controller is remote and most of the traffic is local or uses the local Internet gateway
l Wireless-PCI compliance with remote WiFi controller
l Telecommuting, where the FortiAP unit has the WiFi controller IP address pre-configured and broadcasts the office

SSID in the user’s home or hotel room. In this case, data is sent in the wireless tunnel across the Internet to the
office and you should enable encryption using DTLS.

Remotely-managed FortiAP providing WiFi access to local network

On the remote FortiGate wireless controller, the WiFi SSID is created with the Bridge with FortiAP Interface
option selected. In this mode, no IP addresses are configured. The FortiAP unit’s WiFi and Ethernet interfaces
behave as a switch. WiFi client devices obtain IP addresses from the same DHCP server as wired devices on the
LAN.
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The Local Bridge feature cannot be used in conjunction with Wireless Mesh features.

Block-Intra-SSID Traffic is available in Bridge mode. This is useful in
hotspotdeployments managed by a central FortiGate, but would also be useful in
cloud deployments. Previously, this was only supported in Tunnel mode.

To configure a FortiAP local bridge - web-based manager

1. Go toWiFi & Switch Controller > SSID and select Create New > SSID.
2. Enter:

Interface name A name for the newWiFi interface.

Traffic Mode Local bridge with FortiAP's Interface

SSID The SSID visible to users.

Security Mode
Data Encryption
Preshared Key

Configure security as you would for a regular WiFi network.

3. Select OK.
4. Go toWiFi & Switch Controller > Managed FortiAPs and select the FortiAP unit for editing.
5. Authorize the FortiAP unit.

The FortiAP unit can carry regular SSIDs in addition to the Bridge SSID.

SSID configured for Local Bridge operation

To configure a FortiAP local bridge - CLI

This example creates a WiFi interface “branchbridge” with SSID “LANbridge” using WPA-Personal security,
passphrase “Fortinet1”.
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config wireless-controller vap
edit "branchbridge"

set vdom "root"
set ssid "LANbridge"
set local-bridging enable
set security wpa-personal
set passphrase "Fortinet1"

end
config wireless-controller wtp

edit FAP22B3U11005354
set admin enable
set vaps "branchbridge"

end

Note that:

l Disabling local-bridging forcefully disables local-standalone. Also,
disabling either local-bridging or local-standalone forcefully disables
intra-vap-privacy.

l Enabling intra-vap-privacy forcefully disables local-standalone.
l Enabling local-standalone forcefully enables local-bridging also.

Continued FortiAP operation when WiFi controller connection is down

The wireless controller, or the connection to it, might occasionally become unavailable. During such an outage,
clients already associated with a bridge mode FortiAP unit continue to have access to the WiFi and wired
networks. Optionally, the FortiAP unit can also continue to authenticate users if the SSID meets these conditions:

l Traffic Mode is Local bridge with FortiAP’s Interface.
In this mode, the FortiAP unit does not send traffic back to the wireless controller.

l Security Mode isWPA2 Personal.
These modes do not require the user database. In WPA2 Personal authentication, all clients use the same pre-
shared key which is known to the FortiAP unit.

l Allow New WiFi Client Connections When Controller is down is enabled.
This field is available only if the other conditions have been met.

The “LANbridge” SSID example would be configured like this in the CLI:

config wireless-controller vap
edit "branchbridge"

set vdom "root"
set ssid "LANbridge"
set local-bridging enable
set security wpa-personal
set passphrase "Fortinet1"
set local-authentication enable

end

Using bridged FortiAPs to increase scalability
The FortiGate wireless controller can support more FortiAP units in local bridge mode than in the normal mode.
But this is only true if you configure some of your FortiAP units to operate in remote mode, which supports only
local bridge mode SSIDs.
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The Managed FortAP page (WiFi & Switch Controller > Managed FortiAPs) shows at the top right the
current number of Managed FortiAPs and the maximum number that can be managed, “5/64” for example. The
maximum number, however, is true only if all FortiAP units operate in remote mode. For more detailed
information, consult the Maximum Values Table. For each FortiGate model, there are two maximum values for
managed FortiAP units: the total number of FortiAPs and the number of FortiAPs that can operate in normal
mode.

To configure FortiAP units for remote mode operation

1. Create at least one SSID with Traffic Mode set to Local bridge with FortiAP's Interface.
2. Create a custom AP profile that includes only local bridge SSIDs.
3. Configure each managed FortiAP unit to use the custom AP profile. You also need to set the FortiAP unit’s wtp-

mode to remote, which is possible only in the CLI. The following example uses the CLI both to set wtp-mode
and select the custom AP profile:

config wireless-controller wtp
edit FAP22B3U11005354

set wtp-mode remote
set wtp-profile 220B_bridge

end

1475 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Using Remote WLAN FortiAPs

Remote WLAN FortiAPmodels enable you to provide a pre-configured WiFi access point to a remote or traveling
employee. Once plugged in at home or in a hotel room, the FortiAP automatically discovers the enterprise
FortiGate WiFi controller over the Internet and broadcasts the same wireless SSID used in the corporate office.
Communication between the WiFi controller and the FortiAP is secure, eliminating the need for a VPN.

Split tunneling

By default, all traffic from the remote FortiAP is sent to the FortiGate WiFi controller. If split tunneling is
configured, only traffic destined for the corporate office networks is routed to the FortiGate unit. Other general
Internet traffic is routed unencrypted through the local gateway. Split tunneling avoids loading the FortiGate unit
with unnecessary traffic and allows direct access to local private networks at the FortiAP's location even if the
connection to the WiFi controller goes down.

Note: Split tunneling in WiFi networks differs in implementation from split tunneling in VPN configurations.

By default, split tunneling options are not visible in the FortiGate GUI. You can make these options visible using
the following CLI command:

config system settings
set gui-fortiap-split-tunneling enable

end

Split tunneling is configured inManaged FortiAPs, FortiAP Profiles, and enabled in the SSID.

Configuring the FortiGate for remote FortiAPs
This section assumes that you have already defined SSIDs and now want to make them available to remote
FortiAPs.

l Create FortiAP profiles for the Remote LAN FortiAPmodels
l If split tunneling will be used

l configure override split tunneling in Managed FortiAPs
l enable Split Tunneling in the SSID
l configure the split tunnel networks in the FortiAP profile

Override Split Tunneling

Go toWiFi & Switch Controller > Managed FortiAPs and edit your managed APs. When preconfiguring the
AP to connect to your FortiGate WiFi controller, you can choose to override split tunneling, optionally including
the local subnet of the FortiAP.

Creating FortiAP profiles

If you were not already using Remote LAN FortiAPmodels, you will need to create FortiAP profiles for them. In
the FortiAP profile, you specify the SSIDs that the FortiAP will broadcast. For more information, see "Creating a
FortiAP Profile" on page 1417.
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Configuring split tunneling - FortiGate GUI

Go toWiFi & Switch Controller > SSID and edit your SSID. In theWiFi Settings section, enable Split
Tunneling.

Go toWiFi Controller > FortiAP Profiles and edit the FortiAP Profile(s) that apply to the AP types used in the
WiFi network. In the Split Tunneling section, enable Include Local Subnet and Split Tunneling Subnet(s),
where you can enter a list all of the destination IP address ranges that should not be routed through the the
FortiGate WiFi controller. Packets for these destinations will instead be routed through the remote gateway local
to the FortiAP.

The list of split tunneling subnets includes public Internet destinations and private subnets local to the FortiAP.
Split tunneling public Internet destinations reduces traffic through the FortiGate unit. Split tunneling local private
subnets allows these networks to be accessible to the client behind the FortiAP. Otherwise, private network IP
destinations are assumed to be behind the FortiGate WiFi controller.

Configuring split tunneling - FortiGate CLI

In this example, split tunneling is configured on the example-ssid WiFi network. On FortiAPmodel 21D, traffic
destined for the 192.168.x.x range will not be routed through the FortiGate WiFi controller. This private IP
address range is typically used as a LAN by home routers.

config wireless-controller vap
edit example-ssid

set split-tunneling enable
end

config wireless-controller wtp-profile
edit FAP21D-default

set split-tunneling-acl-local-ap-subnet enable
config split-tunneling-acl

edit 1
set dest-ip 192.168.0.0 255.255.0.0

end
end

To enter multiple subnets, create a split-tunneling-acl entry for each one.

Overriding the split tunneling settings on a FortiAP

If the FortiAP Profile split tunneling settings are not appropriate for a particular FortiAP, you can override the
settings on that unit.

config wireless-controller wtp
edit FAP321C3X14019926

set override-split-tunnel enable
set split-tunneling-acl-local-ap-subnet enable
config split-tunneling-acl

edit 1
set dest-ip 192.168.10.0 255.255.255.0

end
end
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Configuring the FortiAP units
Prior to providing a Remote WLAN FortiAP unit to an employee, you need to preconfigure the AP to connect to
your FortiGate WiFi controller.

To pre-configure a FortiAP

1. Connect the FortiAP to the FortiGate unit.
2. Go toWiFi & Switch Controller > Managed FortiAPs and wait for the FortiAP to be listed. ClickRefresh

periodically to see the latest information. Note the Connected Via IP address.
3. Go to Dashboard. In the CLI Console, log into the FortiAP CLI.

For example, if the IP address is 192.168.1.4, enter:
exec telnet 192.168.1.4

Enter admin at the login prompt. By default, no password is set.

4. Enter the following commands to set the FortiGate WiFi controller IP address. This should be the FortiGate
Internet-facing IP address, in this example 172.20.120.142.
cfg -a AC_IPADDR_1=172.20.120.142
cfg -c

5. Enter exit to log out of the FortiAP CLI.

Preauthorizing FortiAP units
By preauthorizing FortiAP units, you facilitate their automatic authorization on the network. Also, you can assign
each unit a unique name, such as the employee's name, for easier tracking.

1. Go toWiFi & Switch Controller > Managed FortiAPs and create a new entry.
2. Enter the Serial Number of the FortiAP unit and give it a Name. Select the appropriate FortiAP Profile.
3. ClickOK.
Repeat this process for each FortiAP.
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High-density environments such as auditoriums, classrooms, and meeting rooms present a challenge to WiFi
providers. When a large number of mobile devices try to connect to a WiFi network, difficulties arise because of
the limited number of radio channels and interference between devices.

FortiOS and FortiAP devices provide several tools to mitigate the difficulties of high-density environments.

Power save feature
Occasionally, voice calls can become disrupted. One way to alleviate this issue is by controlling the power save
feature, or to disable it altogether.

Manually configure packet transmit optimization settings by entering the following command:

config wireless-controller wtp-profile
edit <name>

config <radio-1> | <radio-2>
set transmit-optimize {disable | power-save | aggr-limit | retry-limit | sendbar}

l disable:Disable transmit optimization.
l power-save:Mark a client as power save mode if excessive transmit retries happen.
l aggr-limit: Set aggregation limit to a lower value when data rate is low.
l retry-limit: Set software retry limit to a lower value when data rate is low.
l send-bar:Do not send BAR frame too often.

11n radio powersave optimization

The following powersave-optimize parameters (under config radio) are used for 11n radios to optimize
system performance for specific situations.

l tim: Set traffic indication map (TIM) bit for client in power save mode. TIM bit mask indicates to any sleeping
listening stations if the AP has any buffered frames present. If enabled, the AP will always indicate to the connected
client that there is a packet waiting in the AP, so it will help to prevent the client from entering a sleep state.

l ac-vo:Use Access Category (AC) Voice (VO) priority to send packets in the power save queue. AC VO is one of the
highest classes/priority levels used to ensure quality of service (QoS). If enabled, when a client returns from a sleep
state, the AP will send its buffered packet using a higher priority queue, instead of the normal priority queue.

l no-obss-scan: Do not put Overlapping Basic Service Set (OBSS), or high-noise (i.e. non-802.11), scan IE into a
Beacon or Probe Response frame.

l no-11b-rate:Do not send frame using 11b data rate.
l client-rate-follow: Adapt transmitting PHY rate with receiving PHY rate from client. If enabled, the AP will

integrate the current client's transmission PHY rate into its rate adaptation algorithm for transmitting.

Broadcast packet suppression
Broadcast packets are sent at a low data rate in WiFi networks, consuming valuable air time. Some broadcast
packets are unnecessary or even potentially detrimental to the network and should be suppressed.
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ARP requests and replies could allow clients to discover each other's IP addresses. On most WiFi networks, intra-
client communication is not allowed, so these ARP requests are of no use, but they occupy air time.

DHCP (upstream) should be allowed so that clients can request an IP address using DHCP.

DHCP (downstream) should be suppressed because it would allow a client to provide DHCP service to other
clients. Only the AP should do this.

NetBIOS is a Microsoft Windows protocol for intra-application communication. Usually this is not required in high-
density deployments.

IPv6 broadcast packets can be suppressed if your network uses IPv4 addressing.

You can configure broadcast packet suppression in the CLI. The following options are available for broadcast
suppression:

config wireless-controller vap
edit <name>

set broadcast-suppression {dhcp-up | dhcp-down | dhcp-starvation | arp-known | arp-
unknown | arp-reply | arp-poison | arp-proxy | netbios-ns | netbios-ds | ipv6 |
all-other-mc | all-other-bc}

end

dhcp-starvation helps prevent clients from depleting the DHCP address pool by making multiple requests.

arp-poison helps prevent clients from spoofing ARPmessages.

Because of all these specific multicast and broadcast packet types, the two options all-other-mc and all-
other-bc help suppress multicast (mc) and broadcast (bc) packets that are not covered by any of the specific
options.

Multicast to unicast conversion
Multicast data such as streaming audio or video are sent at a low data rate in WiFi networks. This causes them to
occupy considerable air time. FortiOS provides a multicast enhancement option that converts multicast streams
to unicast. A unicast stream is sent to each client at high data rate that makes more efficient use of air time. You
can configure multicast-to-unicast conversion in the CLI:

config wireless-controller vap
edit <vap_name>

set multicast-enhance enable
end

Ignore weak or distant clients
Clients beyond the intended coverage area can have some impact on your high-density network. Your APs will
respond to these clients' probe signals, consuming valuable air time. You can configure your WiFi network to
ignore weak signals that most likely come from beyond the intended coverage area. The settings are available in
the CLI:

config wireless-controller vap
edit <vap_name>

set probe-resp-suppression enable
set probe-resp-threshold <level_int>

end

vap_name is the SSID name.
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probe-resp-threshold is the signal strength in dBm below which the client is ignored. The range is -95 to -
20dBm. The default level is -80dBm.

Turn off 802.11b protocol
By disabling support for the obsolete 802.11b protocol, you can reduce the air time that data frames occupy.
These signals will now be sent at a minimum of 6Mbps, instead of 1Mbps. You can set this for each radio in the
FortiAP profile, using the CLI:

config wireless-controller wtp-profile
edit <name_string>

config radio-1
set powersave-optimize no-11b-rate

end

Disable low data rates
Each of the 802.11 protocols supports several data rates. By disabling the lowest rates, air time is conserved,
allowing the channel to serve more users. You can set the available rates for each 802.11 protocol: a, b, g, n, ac.
Data rates set as Basic are mandatory for clients to support. Other specified rates are supported.

The 802.11 a, b, and g protocols are specified by data rate. 802.11a can support 6,9,12, 18, 24, 36, 48, and 54
Mb/s. 802.11b/g can support 1, 2, 5.5, 6, 9,12, 18, 24, 36, 48, 54 Mb/s. Basic rates are specified with the suffix
"basic", "12-basic" for example. The capabilities of expected client devices need to be considered when deciding
the lowest Basic rate.

The 802.11n and ac protocols are specified by the Modulation and Coding Scheme (MCS) Index and the number
of spatial streams.

l 802.11n with 1 or 2 spatial streams can support mcs0/1, mcs1/1, mcs2/1, mcs3/1, mcs4/1, mcs5/1, mcs6/1,
mcs7/1,mcs8/2,mcs9/2, mcs10/2, mcs11/2, mcs12/2, mcs13/2, mcs14/2, mcs15/2.

l 802.11n with 3 or 4 spatial streams can support mcs16/3, mcs17/3, mcs18/3, mcs19/3, mcs20/3, mcs21/3,
mcs22/3, mcs23/3, mcs24/4, mcs25/4, mcs26/4, mcs27/4, mcs28/4, mcs29/4, mcs30/4, mcs31/4.

l 802.11ac with 1 or 2 spatial streams can support mcs0/1, mcs1/1, mcs2/1, mcs3/1, mcs4/1, mcs5/1, mcs6/1,
mcs7/1, mcs8/1, mcs9/1, mcs0/2, mcs1/2, mcs2/2, mcs3/2, mcs4/2, mcs5/2, mcs6/2, mcs7/2, mcs8/2, mcs9/2.

l 802.11ac with 3 or 4 spatial streams can support mcs0/3, mcs1/3, mcs2/3, mcs3/3, mcs4/3, mcs5/3, mcs6/3,
mcs7/3, mcs8/3, mcs9/3, mcs0/4, mcs1/4, mcs2/4, mcs3/4, mcs4/4, mcs5/4, mcs6/4, mcs7/4, mcs8/4, mcs9/4

Here are some examples of setting basic and supported rates.

config wireless-controller vap
edit <vap_name>

set rates-11a 12-basic 18 24 36 48 54
set rates-11bg 12-basic 18 24 36 48 54
set rates-11n-ss34 mcs16/3 mcs18/3 mcs20/3 mcs21/3 mcs22/3 mcs23/3 mcs24/4 mcs25/4
set rates-11ac-ss34 mcs0/3 mcs1/3 mcs2/3 mcs9/4 mcs9/3

end

Limit power
High-density deployments usually cover a small area that has many clients. Maximum AP signal power is usually
not required. Reducing the power reduces interference between APs. Fortinet recommends that you use FortiAP
automatic power control. You can set this in the FortiAP profile.
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1. Go toWiFi & Switch Controller > FortiAP Profiles and edit the profile for your APmodel.
2. For each radio, enable Auto TX Power Control and set the TX Power Low and TX Power High levels. The

default range of 10 to 17dBm is recommended.

Use frequency band load-balancing
In a high-density environment is important to make the best use of the two WiFi bands, 2.4GHz and 5GHz. The
5GHz band has more non-overlapping channels and receives less interference from non-WiFi devices, but not all
devices support it. Clients that are capable of 5GHz operation should be encouraged to use 5GHz rather than the
2.4GHz band.

To load-balance the WiFi bands, you enable Frequency Handoff in the FortiAP profile. In the FortiGate web-
based manager, go toWiFi & Switch Controller > FortiAP Profiles and edit the relevant profile. Or, you can
use the CLI:

config wireless-controller wtp-profile
edit FAP221C-default

config radio-1
set frequency-handoff enable

end

The FortiGate wireless controller continuously performs a scan of all clients in the area and records their signal
strength (RSSI) on each band. When Frequency Handoff is enabled, the AP does not reply to clients on the
2.4GHz band that have sufficient signal strength on the 5GHz band. These clients can associate only on the
5GHz band. Devices that support only 2.4GHz receive replies and associate with the AP on the 2.4GHz band.

Setting the handoff RSSI threshold

The FortiAP applies load balancing to a client only if the client has a sufficient signal level on 5GHz. The
minimum signal strength threshold is set in the FortiAP profile, but is accessible only through the CLI:

config wireless-controller wtp-profile
edit FAP221C-default

set handoff-rssi 25
end

handoff-rssi has a range of 20 to 30. RSSI is a relative measure. The higher the number, the stronger the
signal.

AP load balancing
The performance of an AP is degraded if it attempts to serve too many clients. In high-density environments,
multiple access points are deployed with some overlap in their coverage areas. The WiFi controller can manage
the association of new clients with APs to prevent overloading.

To load-balance between APs, enable AP Handoff in the FortiAP profile. In the FortiGate web-based manager,
go toWiFi & Switch Controller > FortiAP Profiles and edit the relevant profile. Or, you can use the CLI:

config wireless-controller wtp-profile
edit FAP221C-default

config radio-1
set ap-handoff enable

end

When an AP exceeds the threshold (the default is 30 clients), the overloaded AP does not reply to a new client
that has a sufficient signal at another AP.
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Setting the AP load balance threshold

The thresholds for AP handoff are set in the FortiAP profile, but is accessible only through the CLI:

config wireless-controller wtp-profile
edit FAP221C-default

set handoff-sta-thresh 30
set handoff-rssi 25

end

handoff-sta-thresh sets the number of clients at which AP load balancing begins. It has a range of 5 to 35.

handoff-rssi Sets the minimum signal strength that a new client must have at an alternate AP for the
overloaded AP to ignore the client. It has a range of 20 to 30. RSSI is a relative measure. The higher the number,
the stronger the signal.

Application rate-limiting
To prevent particular application types from consuming too much bandwidth, you can use the FortiOS Application
Control feature.

1. Go to Security Profiles > Application Control.
You can use the default profile or create a new one.

2. Click the category, select Traffic Shaping and then select the priority for the category.
Repeat for each category to be controlled.

3. Select Apply.
4. Go to Policy & Objects > IPv4 Policy and edit your WiFi security policy.
5. In Security Profiles, set Application Control ON and select the security profile that you edited.
6. Select OK.

AP Group management and dynamic VLAN assignment
The FortiGate can create FortiAPGroups, underWiFi & Switch Controller > Managed Devices > Managed
FortiAPs by selecting Create New > Managed AP Group, where multiple APs can be managed. AP grouping
allows specific profile settings to be applied to many APs all at once that belong to a certain AP group, simplifying
the administrative workload.

Note that each AP can only belong to one group.

In addition, VLANs can be assigned dynamically based on the group which an AP belongs. When defining an
SSID, underWiFi & Switch Controller > SSID, a setting called VLAN Pooling can be enabled where you
can either assign the VLAN ID of the AP group the device is connected to, to each device as it is detected, or to
always assign the same VLAN ID to a specific device. Dynamic VLAN assignment allows the same SSID to be
deployed to many APs, avoiding the need to produce multiple SSIDs.

Sharing Tunnel SSIDs within a single managed AP between VDOMs as a Virtual AP for
multi-tenancy

This feature provides the ability to move a tunnel mode VAP into a VDOM, similar to an interface/VLAN in
VDOMs. FortiAP is registered into the root VDOM.
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Within a customer VDOM, customer VAPs can be created/added. In the root VDOM, the customer VAP can be
added to the registered FortiAP. Any necessary firewall rules and interfaces can be configured between the two
VDOMs.

Syntax

config wireless-controller global
set wtp-share {enable | disable}

end

FortiAP LED Blinking
This feature allows the administrator to select a FortiAP from the FortiCloud WebUI and set its LED status to
blink in order to help the administrator find that FortiAP in an environment consisting of many APs.

FortiAP-112D, 221C, 223C, 224D, 320C, and 321C (using v5.6.2 B0489) can support LED Blinking.

Syntax

execute wireless-controller led-blink <wtp-id> {on | on 10 | off}

Wireless controller optimization for large deployment - AP image upgrade
This feature allows the administrator to configure a FortiAP to download the WTP image at join time.

Syntax

config wireless-controller global
set image-download {enable | disable}

end
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Wireless IDS
The FortiGate Wireless Intrusion Detection System (WIDS) monitors wireless traffic for a wide range of security
threats by detecting and reporting on possible intrusion attempts. When an attack is detected the FortiGate unit
records a log message.

You can create a WIDS profile to enable these types of intrusion detection:

l Asleap Attack—ASLEAP is a tool used to perform attacks against LEAP authentication.
l Association Frame Flooding—ADenial of Service attack using a large number of association requests. The default

detection threshold is 30 requests in 10 seconds.
l Authentication Frame Flooding—ADenial of Service attack using a large number of association requests. The

default detection threshold is 30 requests in 10 seconds.
l Broadcasting De-authentication—This is a type of Denial of Service attack. A flood of spoofed de-authentication

frames forces wireless clients to de-athenticate, then re-authenticate with their AP.
l EAPOL Packet Flooding—Extensible Authentication Protocol over LAN (EAPOL) packets are used in WPA and

WPA2 authentication. Flooding the APwith these packets can be a denial of service attack. Several types of EAPOL
packets are detected: EAPOL-FAIL, EAPOL-LOGOFF, EAPOL-START, EAPOL-SUCC.

l Invalid MAC OUI—Some attackers use randomly-generated MAC addresses. The first three bytes of the MAC
address are the Organizationally Unique Identifier (OUI), administered by IEEE. Invalid OUIs are logged.

l Long Duration Attack—To share radio bandwidth, WiFi devices reserve channels for brief periods of time.
Excessively long reservation periods can be used as a denial of service attack. You can set a threshold between
1000 and 32 767 microseconds. The default is 8200.

l Null SSID Probe Response—When a wireless client sends out a probe request, the attacker sends a response with
a null SSID. This causes many wireless cards and devices to stop responding.

l Spoofed De-authentication—Spoofed de-authentication frames are a denial of service attack. They cause all clients
to disconnect from the AP.

l WeakWEP IV Detection—A primary means of cracking WEP keys is by capturing 802.11 frames over an extended
period of time and searching for patterns of WEP initialization vectors (IVs) that are known to be weak. WIDS
detects known weakWEP IVs in on-air traffic.

l Wireless Bridge—WiFi frames with both the fromDS and ToDS fields set indicate a wireless bridge. This will also
detect a wireless bridge that you intentionally configured in your network.

You can enable wireless IDS by selecting a WIDS Profile in your FortiAP profile.

To create a WIDS Profile

1. Go toWiFi & Switch Controller > WIDS Profiles.
2. Select a profile to edit or select Create New.
3. Select the types of intrusion to protect against.

By default, all types are selected.
4. Select Apply.
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You can also configure a WIDS profile in the CLI using the config wireless-controller wids-
profile command.

Rogue AP detection

The WIDS profile includes settings for detection of unauthorized (rogue) access points in your wireless network.
For more information, see Wireless network monitoring on page 1489.

WIDS client deauthentication rate for DoS attacks

As part of mitigating a Denial of Service (DoS) attack, the FortiGate sends deauthentication packets to unknown
clients. In an aggressive attack, this deauthentication activity can prevent the processing of packets from valid
clients. AWIDS Profile option in the CLI limits the deauthentication rate.

config wireless-controller wids-profile
edit default

set deauth-unknown-src-thresh <1-65535>
end

The value set is a measure of the number of deathorizations per second. 0 means no limit. The default is 10.

WiFi data channel encryption
Optionally, you can apply DTLS encryption to the data channel between the wireless controller and FortiAP units.
This enhances security.

There are data channel encryption settings on both the FortiGate unit and the FortiAP units. At both ends, you
can enable Clear Text, DTLS encryption, or both. The settings must agree or the FortiAP unit will not be able to
join the WiFi network. By default, both Clear Text and DTLS-encrypted communication are enabled on the
FortiAP unit, allowing the FortiGate setting to determine whether data channel encryption is used. If the
FortiGate unit also enables both Clear Text and DTLS, Clear Text is used.

Data channel encryption settings are located in the FortiAP profile. By default, only Clear Text is supported.

Data channel encryption is software-based and can affect performance. Verify that the
system meets your performance requirements with encryption enabled.

Configuring encryption on the FortiGate unit

You can use the CLI to configure data channel encryption.

Enabling encryption
In the CLI, the wireless wtp-profile command contains a new field, dtls-policy, with options
clear-text and dtls-enabled. To enable encryption in profile1 for example, enter:

config wireless-controller wtp-profile
edit profile1

set dtls-policy dtls-enabled
end

Configuring encryption on the FortiAP unit

The FortiAP unit has its own settings for data channel encryption.
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Enabling CAPWAP encryption - FortiAP web-based manager
1. On the System Information page, inWTP Configuration > AC Data Channel Security, select one of:

l Clear Text
l DTLS Enabled
l Clear Text or DTLS Enabled (default)

2. Select Apply.

Enabling encryption - FortiAP CLI
You can set the data channel encryption using the AP_DATA_CHAN_SEC variable: 'clear', or 'ipsec', or 'dtls'.

For example, to set security to DTLS and then save the setting, enter:

cfg -a AP_DATA_CHAN_SEC=dtls
cfg -c

Protected Management Frames and Opportunisitc Key Caching support
Protected Management Frames (PMF) protect some types of management frames like deauthorization,
disassociation and action frames. This feature, now mandatory on WiFi certified 802.1ac devices, prevents
attackers from sending plain deauthorization/disassociation frames to disrupt or tear down a
connection/association. PMF is a Wi-Fi Alliance specification based on IEEE 802.11w.

To facilitate faster roaming client roaming, you can enable Opportunistic Key Caching (OKC) on your WiFi
network. When a client associates with an AP, its PMK identifier is sent to all other APs on the network. This
eliminates the need for an already-authenticated client to repeat the full EAP exchange process when it roams to
another AP on the same network.

Use of PMF and OKC on an SSID is configurable only in the CLI:

config wireless-controller vap
edit <vap_name>

set pmf {disable | enable | optional}
set pmf-assoc-comeback-timeout <integer>
set pmf-sa-query-retry-timeout <integer>
set okc {disable | enable}

next
end

When pmf is set to optional, it is considered enabled, but will allow clients that do not use PMF. When pmf
is set to enable, PMF is required by all clients.

Bluetooth Low Energy (BLE) Scan
The FortiGate can configure FortiAP Bluetooth Low Energy (BLE) scan, incorporating Google's BLE beacon
profile known as Eddystone, used to identify groups of devices and individual devices.

Currently, only the FAP-S221E, FAP-S223E, and FAP-222Emodels support this
feature.
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Use the following syntax to configure BLE profiles, configure BLE report intervals, and assign BLE profiles to
WTP profiles.

CLI syntax - Configure BLE profiles

config wireless-controller ble-profile
edit <name>

set comment <comment>
set advertising {ibeacon | eddystone-uid | eddystone-url}
set ibeacon-uuid <uuid>
set major-id <0 - 65535> - (default = 1000)
set minor-id <0 - 65535> - (default = 1000)
set eddystone-namespace <10-byte namespace>
set eddystone-instance <device id>
set eddystone-url <url>
set txpower <0 - 12> - (default = 0)
set beacon-interval <40 - 3500> - (default = 100)
set ble-scanning {enable | disable} - (default = disable)

next
end

Note that txpower determines the transmit power level on a scale of 0-12:

0: -21 dBm 1: -18 dBm 2: -15 dBm 3: -12 dBm 4: -9 dBm

5: -6 dBm 6: -3 dBm 7: 0 dBm 8: 1 dBm 9: 2 dBm

10: 3 dBm 11: 4 dBm 12: 5 dBm

CLI syntax - Configure BLE report intervals

config wireless-controller timers
set ble-scan-report-intv - (default = 30 sec)

end

CLI syntax - Assign BLE profiles to WTP profiles

config wireless-controller wtp-profile
edit <name>

set ble-profile <name>
next

end
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You can monitor both your wireless clients and other wireless networks that are available in your coverage area.

Monitoring wireless clients

To view connected clients on a FortiWiFi unit

1. Go toMonitor > Client Monitor.
The following information is displayed:

SSID The SSID that the client connected to.

FortiAP The serial number of the FortiAP unit to which the client connected.

User User name

IP The IP address assigned to the wireless client.

Device

Auth The type of authentication used.

Channel WiFi radio channel in use.

Bandwidth Tx/Rx Client received and transmitted bandwidth, in Kbps.

Signal Strength / Noise The signal-to-noise ratio in deciBels calculated from signal strength and
noise level.

Signal Strength

Association Time How long the client has been connected to this access point.

Results can be filtered. Select the filter icon on the column you want to filter. Enter the values to
include or select NOT if you want to exclude the specified values.

Monitoring rogue APs
The access point radio equipment can scan for other available access points, either as a dedicated monitor or in
idle periods during AP operation.

Discovered access points are listed inMonitor > Rogue AP Monitor. You can then mark them as either
Accepted or Rogue access points. This designation helps you to track access points. It does not affect anyone’s
ability to use these access points.

It is also possible to suppress rogue APs. See Monitoring rogue APs on page 1489.
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On-wire rogue AP detection technique

Other APs that are available in the same area as your own APs are not necessarily rogues. A neighboring AP that
has no connection to your network might cause interference, but it is not a security threat. A rogue AP is an
unauthorized AP connected to your wired network. This can enable unauthorized access. When rogue AP
detection is enabled, theOn-wire column in the Rogue AP Monitor list shows a green up-arrow on detected
rogues.

Rogue APmonitoring of WiFi client traffic builds a table of WiFi clients and the Access Points that they are
communicating through. The FortiGate unit also builds a table of MAC addresses that it sees on the LAN. The
FortiGate unit’s on-wire correlation engine constantly compares the MAC addresses seen on the LAN to the MAC
addresses seen on the WiFi network.

There are two methods of Rogue AP on-wire detection operating simultaneously: Exact MAC address match and
MAC adjacency.

Exact MAC address match

If the same MAC address is seen on the LAN and on the WiFi network, this means that the wireless client is
connected to the LAN. If the AP that the client is using is not authorized in the FortiGate unit configuration, that
AP is deemed an ‘on-wire’ rogue. This scheme works for non-NAT rogue APs.

MAC adjacency

If an access point is also a router, it applies NAT to WiFi packets. This can make rogue detection more difficult.
However, an AP’sWiFi interface MAC address is usually in the same range as its wired MAC address. So, the
MAC adjacency rogue detection method matches LAN and WiFi network MAC addresses that are within a
defined numerical distance of each other. By default, the MAC adjacency value is 7. If the AP for these matching
MAC addresses is not authorized in the FortiGate unit configuration, that AP is deemed an ‘on-wire’ rogue.

Limitations

On-wire rogue detection has some limitations. There must be at least one WiFi client connected to the suspect
AP and continuously sending traffic. If the suspect AP is a router, its WiFi MAC address must be very similar to its
Ethernet port MAC address.

Logging

Information about detected rogue APs is logged and uploaded to your FortiAnalyzer unit, if you have one. By
default, rogue APs generate an alert level log, unknown APs generate a warning level log. This log information
can help you with PCI-DSS compliance requirements.

Rogue AP scanning as a background activity

Each WiFi radio can perform monitoring of radio channels in its operating band while acting as an AP. It does this
by briefly switching from AP to monitoring mode. By default, a scan period starts every 300 seconds. Each second
a different channel is monitored for 20ms until all channels have been checked.

During heavy AP traffic, it is possible for Spectrum Analysis background scanning to cause lost packets when the
radio switches to monitoring. To reduce the probability of lost packets, you can set the CLI ap-bgscan-idle
field to delay the switch to monitoring until the AP has been idle for a specified period. This means that heavy AP
traffic may slow background scanning.
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The following CLI example configures default background rogue scanning operation except that it sets ap-
bgscan-idle to require 100ms of AP inactivity before scanning the next channel.

config wireless-controller wtp-profile
edit ourprofile

config radio-1
set wids-profile ourwidsprofile
set spectrum-analysis enable

end
end

config wireless-controller wids-profile
edit ourwidsprofile

set ap-scan enable
set rogue-scan enable
set ap-bgscan-period 300
set ap-bgscan-intv 1
set ap-bgscan-duration 20
set ap-bgscan-idle 100

end

Configuring rogue scanning

All APs using the same FortiAP Profile share the same rogue scanning settings, unless override is configured.

To enable rogue AP scanning with on-wire detection - web-based manager

1. Go toWiFi & Switch Controller > WIDS Profiles.
On some models, the menu isWiFi & Switch Controller.

2. Select an existing WIDS Profile and edit it, or select Create New.
3. Make sure that Enable Rogue AP Detection is selected.
4. Select Enable On-Wire Rogue AP Detection.
5. Optionally, enable Auto Suppress Rogue APs in Foreground Scan.
6. Select OK.

To enable the rogue AP scanning feature in a custom AP profile - CLI

config wireless-controller wids-profile
edit FAP220B-default

set ap-scan enable
set rogue-scan enable

end

Exempting an AP from rogue scanning

By default, if Rogue APDetection is enabled, it is enabled on all managed FortiAP units. Optionally, you can
exempt an AP from scanning. You should be careful about doing this if your organization must perform scanning
to meet PCI-DSS requirements.

To exempt an AP from rogue scanning

1. Go toWiFi & Switch Controller > WIDS Profiles.
2. Create a newWIDS profile and disable Rogue AP detection.
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3. Go toWiFi & Switch Controller > FortiAP Profiles and edit the profile you wish to exempt from rogue
scanning.

4. Assign the WIDS profile created in step 2.

MAC adjacency

You can adjust the maximum WiFi to Ethernet MAC difference used when determining whether an suspect AP is
a rogue.

To adjust MAC adjacency

For example, to change the adjacency to 8, enter

config wireless-controller global
set rogue-scan-mac-adjacency 8

end
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Using the Rogue AP Monitor

Go toMonitor > Rogue AP Monitor to view the list of other wireless access points that are receivable at your
location.

Information Columns
Actual columns displayed depends onColumn Settings.

State

Rogue AP— Use this status for unauthorized APs that On-wire status indicates are
attached to your wired networks.

Accepted AP— Use this status for APs that are an authorized part of your network or
are neighboring APs that are not a security threat. To see accepted APs in the list,
select Show Accepted.

Unclassified — This is the initial status of a discovered AP. You can change an AP back
to unclassified if you have mistakenly marked it as Rogue or Accepted.

Online
Status

Active AP

Inactive AP

Active ad-hocWiFi device

Inactive ad-hocWiFi device

SSID The wireless service set identifier (SSID) or network name for the wireless interface.

Security
Type

The type of security currently being used.

Channel The wireless radio channel that the access point uses.

MAC
Address

The MAC address of the Wireless interface.

Vendor
Info The name of the vendor.

Signal
Strength

The relative signal strength of the AP. Mouse over the symbol to view the signal-to-noise
ratio.

Detected
By The name or serial number of the AP unit that detected the signal.

On-wire A green up-arrow indicates a suspected rogue, based on the on-wire detection technique. A
red down-arrow indicates AP is not a suspected rogue.

First Seen How long ago this AP was first detected.
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Last Seen How long ago this AP was last detected.

Rate Data rate in bps.

To change the Online Status of an AP, right-click it and select Mark Accepted or Mark Rogue.

Suppressing rogue APs
In addition to monitoring rogue APs, you can actively prevent your users from connecting to them. When
suppression is activated against an AP, the FortiGate WiFi controller sends deauthentication messages to the
rogue AP’s clients, posing as the rogue AP, and also sends deauthentication messages to the rogue AP, posing
as its clients. This is done using the monitoring radio.

Before enabling this feature, verify that operation of Rogue Suppression is compliant
with the applicable laws and regulations of your region.

To enable rogue AP suppression, you must enable monitoring of rogue APs with the on-wire detection technique.
See “Monitoring rogue APs”. The monitoring radio must be in the Dedicated Monitor mode.

To activate AP suppression against a rogue AP

1. Go toMonitor > Rogue AP Monitor.
2. When you see an AP listed that is a rogue detected “on-wire”, select it and then select Mark > Mark Rogue.
3. To suppress an AP that is marked as a rogue, select it and then select Suppress AP.

To deactivate AP suppression

1. Go toMonitor > Rogue AP Monitor.
2. Select the suppressed rogue AP and then select Suppress AP > Unsuppress AP.

Monitoring wireless network health
To view the wireless health dashboard, go toMonitor > WiFi Health Monitor.

The wireless health dashboard provides a comprehensive view of the health of your network’s wireless
infrastructure. The dashboard includes widgets to display

l AP Status - Active, Down or missing, up for over 24 hours, rebooted in past 24 hours
l Client Count Over Time - viewable for past hour, day, or 30 days
l Top Client Count Per-AP - separate widgets for 2.4GHz and 5GHz bands
l Top Wireless Interference - separate widgets for 2.4GHz and 5GHz bands, requires spectrum analysis to be

enabled on the radios
l Login Failures Information

The list of active clients also showsMAC address entries (similar to theWiFi Client Monitor page), making
client information easy to view when opening the Active Clientwidget.
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This chapter shows how to configure typical wireless network clients to connect to a wireless network with WPA-
Enterprise security.

Windows XP client

To configure the WPA-Enterprise network connection

1. In the Windows Start menu, go to Control Panel > Network Connections > Wireless Network Connection
or select the wireless network icon in the Notification area of the Taskbar. A list of available networks is displayed.

If you are already connected to another wireless network, the Connection Status window displays.
Select View Wireless Networks on theGeneral tab to view the list.

If the network broadcasts its SSID, it is listed. But do not try to connect until you have completed the
configuration step below. Because the network doesn’t use the Windows XP default security
configuration, configure the client’s network settings manually before trying to connect.
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2. You can configure the WPA-Enterprise network to be accessible from the View Wireless Networkswindow even
if it does not broadcast its SSID.

3. Select Change Advanced Settings and then select theWireless Networks tab.

Any existing networks that you have already configured are listed in the Preferred Networks list.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1496



Configuring wireless network clients

4. Select Add and enter the following information:

Network Name (SSID) The SSID for your wireless network

Network Authentication WPA2

Data Encryption AES

5. If this wireless network does not broadcast its SSID, select Connect even if this network is not broadcasting
so that the network will appear in the View Wireless Networks list.
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6. Select the Authentication tab.

7. In EAP Type, select Protected EAP (PEAP).
8. Make sure that the other two authentication options are not selected.
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9. Select Properties.

10. Make sure that Validate server certificate is selected.
11. Select the server certificate Entrust Root Certification Authority.
12. In Select Authentication Method, select Secured Password (EAP-MSCHAPv2).
13. Ensure that the remaining options are not selected.
14. Select Configure.

15. If your wireless network credentials are the same as your Windows logon credentials, select Automatically use
my Windows logon name and password. Otherwise, make sure that this option is not selected.

16. Select OK. Repeat until you have closed all of theWireless Network Connection Propertieswindows.
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To connect to the WPA-Enterprise wireless network

1. Select the wireless network icon in the Notification area of the Taskbar.
2. In the View Wireless Networks list, select the network you just added and then select Connect.

You might need to log off of your current wireless network and refresh the list.
3. When the following popup displays, click on it.

4. In the Enter Credentialswindow, enter your wireless networkUser name, Password, and Logon domain (if
applicable). Then, select OK.

In future, Windows will automatically send your credentials when you log on to this network.

Windows 7 client
1. In the Windows Start menu, go to Control Panel > Network and Internet > Network and Sharing Center >

Manage Wireless Networks or select the wireless network icon in the Notification area of the Taskbar. A list of
available networks is displayed.
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2. Do one of the following:
l If the wireless network is listed (it broadcasts its SSID), select it from the list.
l Select Add >Manually create a network profile.
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3. Enter the following information and select Next.

Network name Enter the SSID of the wireless network.
(Required only if you selected Add.)

Security type WPA2-Enterprise

Encryption type AES

Start this connection
automatically

Select

Connect even if the
network is not
broadcasting.

Select

The Wireless Network icon will display a popup requesting that you click to enter credentials for the
network. Click on the popup notification.

4. In the Enter Credentialswindow, enter your wireless networkUser name, Password, and Logon domain (if
applicable). Then, select OK.

5. Select Change connection settings.
6. On the Connection tab, select Connect automatically when this network is in range.
7. On the Security tab, select the Microsoft PEAP authentication method and then select Settings.
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8. Make sure that Validate server certificate is selected.
9. Select the server certificate Entrust Root Certification Authority.
10. In Select Authentication Method, select Secured Password (EAP-MSCHAPv2).
11. Select Configure.

12. If your wireless network credentials are the same as your Windows logon credentials, select Automatically use
my Windows logon name and password. Otherwise, make sure that this option is not selected.

13. Ensure that the remaining options are not selected.
14. Select OK. Repeat until you have closed all of theWireless Network Propertieswindows.
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Mac OS client

To configure network preferences

1. Right-click the AirPort icon in the toolbar and select Open Network Preferences.
2. Select Advanced and then select the 802.1X tab.

3. If there are no Login Window Profiles in the left column, select the + button and then select Add Login Window
Profile.

4. Select the Login Window Profile and then make sure that both TTLS and PEAP are selected in Authentication.

To configure the WPA-Enterprise network connection

1. Select the AirPort icon in the toolbar.
2. Do one of the following:

l If the network is listed, select the network from the list.
l Select Connect to Other Network.
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One of the following windows opens, depending on your selection.

3. Enter the following information and select OK or Join:

Network name Enter the SSID of your wireless network. (Other network only)

Wireless Security WPAEnterprise

802.1X Automatic

Username
Password

Enter your logon credentials for the wireless network.

Remember this network Select.

You are connected to the wireless network.

Mac OS supports only PEAPwith MSCHAPv2 authentication and therefore can
authenticate only to a RADIUS server, not an LDAP or TACACS+ server
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Linux client
This example is based on the Ubuntu 10.04 Linux wireless client.

To connect to a WPA-Enterprise network

1. Select the Network Manager icon to view the Wireless Networks menu.

Wireless networks that broadcast their SSID are listed in the Available section of the menu. If the list is long, it is
continued in theMore Networks submenu.

2. Do one of the following:
l Select the network from the list (also checkMore Networks).
l Select Connect to Hidden Wireless Network.

One of the following windows opens, depending on your selection.
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3. Enter the following information:

Connection Leave asNew. (Hidden network only)

Network name Enter the SSID of your wireless network. (Hidden network only)

Wireless Security WPA&WPA2 Enterprise

Authentication Protected EAP (PEAP) for RADIUS-based authentication

Tunneled TLS for TACACS+ or LDAP-based authentication

Anonymous identity This is not required.

CA Certificate If you want to validate the AP’s certificate, select the Entrust Root
Certification Authority root certificate. The default location for the
certificate is /usr/share/ca-certificates/mozilla/.

PEAP version Automatic (applies only to PEAP)

Inner authentication MSCHAPv2 for RADIUS-based authentication

PAP or CHAP for TACACS+ or LDAP-based authentication

Username
Password

Enter your logon credentials for the wireless network.
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4. If you did not select a CACertificate above, you are asked to do so. Select Ignore.

5. Select Connect. You are connected to the wireless network.

To connect to a WPA-Enterprise network

1. Select the Network Manager icon to view the Wireless Networks menu.
2. Select the network from the list (also checkMore Networks).

If your network is not listed (but was configured), select Connect to Hidden Wireless Network, select your
network from the Connection drop-down list, and then select Connect.

Troubleshooting
Using tools provided in your operating system, you can find the source of common wireless networking problems.

Checking that client received IP address and DNS server information

Windows XP

1. Double-click the network icon in the taskbar to display theWireless Network Connection Statuswindow.
Check that the correct network is listed in the Connection section.

2. Select the Support tab.
Check that the Address Type isAssigned by DHCP. Check that the IP Address, Subnet Mask, and
Default Gateway values are valid.

3. Select Details to view the DNS server addresses.
The listed address should be the DNS serves that were assigned to the WAP. Usually a wireless network that
provides access to the private LAN is assigned the same DNS servers as the wired private LAN. A wireless network
that provides guest or customer users access to the Internet is usually assigned public DNS servers.

4. If any of the addresses are missing, select Repair.
If the repair procedure doesn’t correct the problem, check your network settings.

Mac OS

1. From the Apple menu, open System Preferences > Network.
2. Select AirPort and then select Configure.
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3. On the Network page, select the TCP/IP tab.

4. If there is no IP address or the IP address starts with 169, select Renew DHCP Lease.
5. To check DNS server addresses, open a terminal window and enter the following command:

cat /etc/resolv.conf

Check the listed nameserver addresses. A network for employees should us the wired private LAN
DNS server. A network for guests should specify a public DNS server.

Linux

This example is based on the Ubuntu 10.04 Linux wireless client.
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1. Right-click the Network Manager icon and select Connection Information.

2. Check the IP address, and DNS settings. If they are incorrect, check your network settings.
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This chapter provides an example wireless network configuration.

Basic wireless network
This example uses automatic configuration to set up a basic wireless network.

To configure this wireless network, you must:

l Configure authentication for wireless users
l Configure the SSID (WiFi network interface)
l Add the SSID to the FortiAP Profile
l Configure the firewall policy
l Configure and connect FortiAP units

Configuring authentication for wireless users

You need to configure user accounts and add the users to a user group. This example shows only one account,
but multiple accounts can be added as user group members.

To configure a WiFi user - web-based manager

1. Go to User & Device > User Definition and select Create New.
2. Select Local User and then clickNext.
3. Enter a User Name and Password and then clickNext.
4. ClickNext.
5. Make sure that Enable is selected and then clickCreate.

To configure the WiFi user group - web-based manager

1. Go to User & Device > User Groups and select Create New.
2. Enter the following information and then select OK:

Name wlan_users

Type Firewall

Members Add users.

To configure a WiFi user and the WiFi user group - CLI

config user user
edit "user01"

set type password
set passwd "asdf12ghjk"

end
config user group
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edit "wlan_users"
set member "user01"

end

Configuring the SSID

First, establish the SSID (network interface) for the network. This is independent of the number of physical access
points that will be deployed. The network assigns IP addresses using DHCP.

To configure the SSID - web-based manager

1. Go toWiFi & Switch Controller > SSID and select Create New > SSID.
2. Enter the following information and select OK:

Interface Name example_wifi_if

Traffic Mode Tunnel to Wireless Controller

IP/Network Mask 10.10.110.1/24

Administrative Access Ping (to assist with testing)

DHCP Server Enable

Address Range 10.10.110.2 - 10.10.110.199

Netmask 255.255.255.0

Default Gateway Same As Interface IP

DNS Server Same as System DNS

SSID example_wifi

Security Mode WPA2 Enterprise

Authentication Local, select wlan_users user group.

Leave other settings at their default values.

To configure the SSID - CLI

config wireless-controller vap
edit example_wifi_if

set ssid "example_wifi"
set broadcast-ssid enable
set security wpa-enterprise
set auth usergroup
set usergroup wlan_users
set schedule always

end
config system interface

edit example_wifi_if
set ip 10.10.110.1 255.255.255.0

end
config system dhcp server
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edit 0
set default-gateway 10.10.110.1

set dns-service default
set interface "example_wifi_if"
config ip-range

edit 1
set end-ip 10.10.110.199
set start-ip 10.10.110.2

end
set netmask 255.255.255.0

end

Adding the SSID to the FortiAP Profile

The radio portion of the FortiAP configuration is contained in the FortiAP Profile. By default, there is a profile for
each platform (FortiAPmodel). You can create additional profiles if needed. The SSID needs to be specified in
the profile.

To add the SSID to the FortiAP Profile - web-based manager

1. Go toWiFi & Switch Controller > FortiAP Profiles and edit the profile for your model of FortiAP unit.
2. In Radio 1 and Radio 2, add example_wifi in SSID.
3. Select OK.

Configuring security policies

A security policy is needed to enable WiFi users to access the Internet on port1. First you create firewall address
for the WiFi network, then you create the example_wifi to port1 policy.

To create a firewall address for WiFi users - web-based manager

1. Go to Policy & Objects > Addresses.
2. Select Create New > Address, enter the following information and select OK.

Name wlan_user_net

Type IP/Netmask

Subnet / IP Range 10.10.110.0/24

Interface example_wifi_if

Show in Address List Enabled

To create a firewall address for WiFi users - CLI

config firewall address
edit "wlan_user_net"

set associated-interface "example_wifi_if"
set subnet 10.10.110.0 255.255.255.0

end
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To create a security policy for WiFi users - web-based manager

1. Go to Policy & Objects > IPv4 Policyand select Create New.
2. Enter the following information and select OK:

Incoming Interface example_wifi_if

Source Address wlan_user_net

Outgoing Interface port1

Destination Address All

Schedule always

Service ALL

Action ACCEPT

NAT ON. Select Use Destination Interface Address (default).

Leave other settings at their default values.

To create a firewall policy for WiFi users - CLI

config firewall policy
edit 0

set srcintf "example_wifi"
set dstintf "port1"
set srcaddr "wlan_user_net"
set dstaddr "all"
set schedule always
set service ALL
set action accept
set nat enable

end

Connecting the FortiAP units

You need to connect each FortiAP unit to the FortiGate unit, wait for it to be recognized, and then assign it to the
AP Profile. But first, you must configure the interface to which the FortiAP units connect and the DHCP server that
assigns their IP addresses.

In this example, the FortiAP units connect to port 3 and are controlled through IP addresses on the
192.168.8.0/24 network.

To configure the interface for the AP unit - web-based manager

1. Go to Network > Interfaces and edit the port3 interface.
2. Set the Addressing mode to Dedicated to Extension Device and set the IP/Network Mask to

192.168.8.1/255.255.255.0.
3. Select OK.
This procedure automatically configures a DHCP server for the AP units.
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To configure the interface for the AP unit - CLI

config system interface
edit port3

set mode static
set ip 192.168.8.1 255.255.255.0

end

To configure the DHCP server for AP units - CLI

config system dhcp server
edit 0

set interface port3
config exclude-range

edit 1
set end-ip 192.168.8.1
set start-ip 192.168.8.1

end
config ip-range

edit 1
set end-ip 192.168.8.254
set start-ip 192.168.8.2

end
set netmask 255.255.255.0
set vci-match enable
set vci-string "FortiAP"

end

To connect a FortiAP unit - web-based manager

1. Go toWiFi & Switch Controller > Managed FortiAPs.
2. Connect the FortiAP unit to port 3.
3. Periodically select Refresh while waiting for the FortiAP unit to be listed.

Recognition of the FortiAP unit can take up to two minutes.
If FortiAP units are connected but cannot be recognized, try disabling VCI-Match in the DHCP server settings.

4. When the FortiAP unit is listed, select the entry to edit it.
The Edit Managed Access Pointwindow opens.

5. In State, select Authorize.
6. In FortiAP Profile, select the default profile for the FortiAPmodel.
7. Select OK.
8. Repeat Steps 2 through 8 for each FortiAP unit.

To connect a FortiAP unit - CLI

1. Connect the FortiAP unit to port 3.
2. Enter

config wireless-controller wtp

3. Wait 30 seconds, then enter get.
Retry the get command every 15 seconds or so until the unit is listed, like this:

== [ FAP22B3U10600118 ]
wtp-id: FAP22B3U10600118
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4. Edit the discovered FortiAP unit like this:
edit FAP22B3U10600118

set admin enable
end

5. Repeat Steps 2 through 4 for each FortiAP unit.

A more complex example
This example creates multiple networks and uses custom AP profiles.

Scenario

In this example, Example Co. provides two wireless networks, one for its employees and the other for customers
or other guests of its business. Guest users have access only to the Internet, not to the company’s private
network. The equipment for these WiFi networks consists of FortiAP-220B units controlled by a FortiGate unit.

The employee network operates in 802.11n mode on both the 2.4GHz and 5GHz bands. Client IP addresses are
in the 10.10.120.0/24 subnet, with 10.10.120.1 the IP address of the WAP. The guest network also operates in
802.11n mode, but only on the 2.4GHz band. Client IP addresses are on the 10.10.115.0/24 subnet, with
10.10.115.1 the IP address of the WAP.

On FortiAP-220B units, the 802.11n mode also supports 802.11g and 802.11b clients on the 2.4GHz band and
802.11a clients on the 5GHz band.

The guest networkWAP broadcasts its SSID, the employee networkWAP does not.

The employees network usesWPA-Enterprise authentication through a FortiGate user group. The guest network
features a captive portal. When a guest first tries to connect to the Internet, a login page requests logon
credentials. Guests use numbered guest accounts authenticated by RADIUS. The captive portal for the guests
includes a disclaimer page.

In this example, the FortiAP units connect to port 3 and are assigned addresses on the 192.168.8.0/24 subnet.

Configuration

To configure these wireless networks, you must:

l Configure authentication for wireless users
l Configure the SSIDs (network interfaces)
l Configure the AP profile
l Configure the WiFi LAN interface and a DHCP server
l Configure firewall policies

Configuring authentication for employee wireless users

Employees have user accounts on the FortiGate unit. This example shows creation of one user account, but you
can create multiple accounts and add them as members to the user group.

To configure a WiFi user - web-based manager

1. Go to User & Device > User Definition and select Create New.
2. Select Local User and then clickNext.
3. Enter a User Name and Password and then clickNext.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1516



Wireless network examples

4. ClickNext.
5. Make sure that Enable is selected and then clickCreate.

To configure the user group for employee access - web-based manager

1. Go to User & Device > User Groups and select Create New.
2. Enter the following information and then select OK:

Name employee-group

Type Firewall

Members Add users.

To configure a WiFi user and the user group for employee access - CLI

config user user
edit "user01"

set type password
set passwd "asdf12ghjk"

end
config user group

edit "employee-group"
set member "user01"

end

The user authentication setup will be complete when you select the employee-group in the SSID configuration.

Configuring authentication for guest wireless users

Guests are assigned temporary user accounts created on a RADIUS server. The RADIUS server stores each
user’s group name in the Fortinet-Group-Name attribute. Wireless users are in the group named “wireless”.

The FortiGate unit must be configured to access the RADIUS server.

To configure the FortiGate unit to access the guest RADIUS server - web-based manager

1. Go to User & Device > RADIUS Servers and select Create New.
2. Enter the following information and select OK:

Name guestRADIUS

Primary Server IP/Name 10.11.102.100

Primary Server Secret grikfwpfdfg

Secondary Server IP/Name Optional

Secondary Server Secret Optional

Authentication Scheme Use default, unless server requires otherwise.

Leave other settings at their default values.
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To configure the FortiGate unit to access the guest RADIUS server - CLI

config user radius
edit guestRADIUS

set auth-type auto
set server 10.11.102.100
set secret grikfwpfdfg

end

To configure the user group for guest access - web-based manager

1. Go to User & Device > User Groups and select Create New.
2. Enter the following information and then select OK:

Name guest-group

Type Firewall

Members Leave empty.

3. Select Create new.
4. Enter:

Remote Server Select guestRADIUS.

Groups Select wireless

5. Select OK.

To configure the user group for guest access - CLI

config user group
edit "guest-group"

set member "guestRADIUS"
config match

edit 0
set server-name "guestRADIUS"
set group-name "wireless"

end
end

The user authentication setup will be complete when you select the guest-group user group in the SSID
configuration.

Configuring the SSIDs

First, establish the SSIDs (network interfaces) for the employee and guest networks. This is independent of the
number of physical access points that will be deployed. Both networks assign IP addresses using DHCP.

To configure the employee SSID - web-based manager

1. Go toWiFi & Switch Controller > SSID and select Create New > SSID.
2. Enter the following information and select OK:
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Interface Name example_inc

Traffic Mode Tunnel to Wireless Controller

IP/Netmask 10.10.120.1/24

Administrative Access Ping (to assist with testing)

Enable DHCP Enable

  Address Range 10.10.120.2 - 10.10.120.199

  Netmask 255.255.255.0

  Default Gateway Same As Interface IP

  DNS Server Same as System DNS

SSID example_inc

Security Mode WPA/WPA2-Enterprise

Authentication Select Local, then select employee-group.

Leave other settings at their default values.

To configure the employee SSID - CLI

config wireless-controller vap
edit example_inc

set ssid "example_inc"
set security wpa-enterprise
set auth usergroup
set usergroup employee-group
set schedule always

end
config system interface

edit example_inc
set ip 10.10.120.1 255.255.255.0

end
config system dhcp server

edit 0
set default-gateway 10.10.120.1
set dns-service default
set interface example_inc
config ip-range

edit 1
set end-ip 10.10.120.199
set start-ip 10.10.120.2

end
set lease-time 7200
set netmask 255.255.255.0

end
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To configure the example_guest SSID - web-based manager

1. Go toWiFi & Switch Controller > SSID and select Create New.
2. Enter the following information and select OK:

Name example_guest

IP/Netmask 10.10.115.1/24

Administrative Access Ping (to assist with testing)

Enable DHCP Enable

  Address Range 10.10.115.2 - 10.10.115.50

  Netmask 255.255.255.0

  Default Gateway Same as Interface IP

  DNS Server Same as System DNS

SSID example_guest

Security Mode Captive Portal

Portal Type Authentication

Authentication Portal Local

User Groups Select guest-group

Leave other settings at their default values.

To configure the example_guest SSID - CLI

config wireless-controller vap
edit example_guest

set ssid "example_guest"
set security captive-portal
set selected-usergroups guest-group
set schedule always

end
config system interface

edit example_guest
set ip 10.10.115.1 255.255.255.0

end
config system dhcp server

edit 0
set default-gateway 10.10.115.1
set dns-service default
set interface "example_guest"
config ip-range

edit 1
set end-ip 10.10.115.50
set start-ip 10.10.115.2

end
set lease-time 7200
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set netmask 255.255.255.0
end

Configuring the FortiAP profile

The FortiAP Profile defines the radio settings for the networks. The profile provides access to both Radio 1
(2.4GHz) and Radio 2 (5GHz) for the employee virtual AP, but provides access only to Radio 1 for the guest
virtual AP.

To configure the FortiAP Profile - web-based manager

1. Go toWiFi & Switch Controller > FortiAP Profiles and select Create New.
2. Enter the following information and select OK:

Name example_AP

Platform FAP220B

Radio 1

  Mode Access Point

  Band 802.11n

  Channel Select 1, 6, and 11.

  Tx Power 100%

  SSID Select SSIDs and select example_inc and example_guest.

Radio 2

  Mode Access Point

  Band 802.11n_5G

  Channel Select all.

  Tx Power 100%

  SSID Select SSIDs and select example_inc.

To configure the AP Profile - CLI

config wireless-controller wtp-profile
edit "example_AP"

config platform
set type 220B

end
config radio-1

set ap-bgscan enable
set band 802.11n
set channel "1" "6" "11"
set vaps "example_inc" "example_guest"

end
config radio-2
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set ap-bgscan enable
set band 802.11n-5G
set channel "36" "40" "44" "48" "149" "153" "157" "161" "165"
set vaps "example_inc"

end

Configuring firewall policies

Identity-based firewall policies are needed to enable the WLAN users to access the Internet on Port1. First you
create firewall addresses for employee and guest users, then you create the firewall policies.

To create firewall addresses for employee and guest WiFi users

1. Go to Policy & Objects > Addresses.
2. Select Create New, enter the following information and select OK.

Address Name employee-wifi-net

Type Subnet / IP Range

Subnet / IP Range 10.10.120.0/24

Interface example_inc

3. Select Create New, enter the following information and select OK.

Address Name guest-wifi-net

Type Subnet / IP Range

Subnet / IP Range 10.10.115.0/24

Interface example_guest

To create firewall policies for employee WiFi users - web-based manager

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and select OK:

Incoming Interface example_inc

Source Address employee-wifi-net

Outgoing Interface port1

Destination Address all

Schedule always

Service ALL

Action ACCEPT

NAT Enable NAT
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3. Optionally, select security profile for wireless users.
4. Select OK.
5. Repeat steps 1 through 4 but select Internal as the Destination Interface/Zone to provides access to the

ExampleCo private network.

To create firewall policies for employee WiFi users - CLI

config firewall policy
edit 0

set srcintf "employee_inc"
set dstintf "port1"
set srcaddr "employee-wifi-net"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"
set nat enable
set schedule "always"

next
edit 0

set srcintf "employee_inc"
set dstintf "internal"
set srcaddr "employee-wifi-net"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"
set nat enable
set schedule "always"

end

To create a firewall policy for guest WiFi users - web-based manager

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and select OK:

Incoming Interface example_guest

Source Address guest-wifi-net

Outgoing Interface port1

Destination Address all

Schedule always

Service ALL

Action ACCEPT

NAT Enable NAT

3. Optionally, select UTM and set up UTM features for wireless users.
4. Select OK.
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To create a firewall policy for guest WiFi users - CLI

config firewall policy
edit 0

set srcintf "example_guest"
set dstintf "port1"
set srcaddr "guest-wifi-net"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"
set nat enable

end

Connecting the FortiAP units

You need to connect each FortiAP-220A unit to the FortiGate unit, wait for it to be recognized, and then assign it
to the AP Profile. But first, you must configure the interface to which the FortiAP units connect and the DHCP
server that assigns their IP addresses.

In this example, the FortiAP units connect to port 3 and are controlled through IP addresses on the
192.168.8.0/24 network.

To configure the interface for the AP unit - web-based manager

1. Go to Network > Interfaces and edit the port3 interface.
2. Set the Addressing mode to Dedicated to Extension Device and set the IP/Netmask to

192.168.8.1/255.255.255.0.
This step automatically configures a DHCP server for the AP units.

3. Select OK.

To configure the interface for the AP unit - CLI

config system interface
edit port3

set mode static
set ip 192.168.8.1 255.255.255.0

end

To configure the DHCP server for AP units - CLI

config system dhcp server
edit 0

set interface port3
config ip-range

edit 1
set end-ip 192.168.8.9
set start-ip 192.168.8.2

end
set netmask 255.255.255.0
set vci-match enable
set vci-string "FortiAP"

end
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To connect a FortiAP-220A unit - web-based manager

1. Go toWiFi & Switch Controller > Managed FortiAPs.
2. Connect the FortiAP unit to port 3.
3. Periodically select Refresh while waiting for the FortiAP unit to be listed.

Recognition of the FortiAP unit can take up to two minutes.
If there is persistent difficulty recognizing FortiAP units, try disabling VCI-Match in the DHCP server settings.

4. When the FortiAP unit is listed, select the entry to edit it.
The Edit Managed Access Pointwindow opens.

5. In State, select Authorize.
6. In the AP Profile, select [Change] and then select the example_AP profile.
7. Select OK.
8. Repeat Steps 2 through 8 for each FortiAP unit.

To connect a FortiAP-220A unit - CLI

1. Connect the FortiAP unit to port 3.
2. Enter:

config wireless-controller wtp

3. Wait 30 seconds, then enter get.
Retry the get command every 15 seconds or so until the unit is listed, like this:

== [ FAP22A3U10600118 ]
wtp-id: FAP22A3U10600118

4. Edit the discovered FortiAP unit like this:
edit FAP22A3U10600118

set admin enable
set wtp-profile example_AP

end

5. Repeat Steps 2 through 4 for each FortiAP unit.
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This chapter provides a few FortiCloud-managed FortiAP configuration examples.

You can register for a free FortiCloud account at www.forticloud.com.

For a video tutorial of how to configure and manage a FortiAP-S device from FortiCloud, follow the link below:

l How to configure and Manage FortiAP-S from FortiCloud

FortiCloud-managed FortiAP WiFi
In this example, you use FortiCloud to configure a single FortiAP-221C, creating a working WiFi network without
a FortiGate unit.

FortiCloud remote management is supported on FortiAPmodels 221C and 320C.

For this configuration, the FortiAP-221C unit is running version 5.2 firmware. You will create a simple network
that usesWPA-Personal authentication.

You can register for a free FortiCloud account at www.forticloud.com.

To create the WiFi network without a FortiGate unit, you must:

l Add your FortiAP to FortiCloud
l Configure the SSID
l Configure the AP platform profile
l Deploy the APwith the profile

Adding your FortiAP to FortiCloud

You need to add the FortiAP unit to your FortiCloud account. This is done through a unique key that can be found
under the FortiAP unit.

To add a FortiAP to FortiCloud

1. Connect the FortiAP Ethernet interface to a network that provides access to the Internet.
2. Open a web browser and navigate to the FortiCloud main page and select + AP Network.
3. Enter an AP Network Name and AP Password. This password is used to locally log in to the AP as the

administrator. It will be set to all APs in this AP network.
4. Set the correct Time Zone and select Submit.

Configuring the SSID

You must establish the SSID (network interface) for the WiFi network.

To configure the SSID

1. Select the FortiAP you just created from the home page. You will then be prompted to add an SSID for the
AP Network.
In the interface, this is underConfigure > SSIDs.
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2. In Access Control, enter the name of your SSID, set Authentication toWPA2-Personal, enter the Pre-
shared Key, and select Next.

3. In Security, enable security features as required (select from AntiVirus, Intrusion Prevention, Block Botnet,
Web Access, and Application Control) and select Next.

4. In Availability, make sure to leave 5 GHz enabled, configure a schedule as required, and select Next.
5. Review your SSID in Preview, then select Apply.

Configuring the AP platform profile

The radio portion of the FortiAP configuration is contained in the FortiAP platform profile. By default, there is a
profile for each platform (FortiAPmodel). The SSID needs to be specified in the profile.

To configure the AP profile

1. Go to Configure > AP Profile and edit the AP Profile for your FortiAPmodel (mouse-over the AP Profile to
reveal the Edit button).

2. Enable the SSID configured earlier for both Radio 1 and Radio 2, for 5GHz coverage.

Deploying the AP with the platform profile

With the SSID and platform profile configured, you must deploy the AP by entering the FortiCloud key for the
FortiAP.

To deploy the AP

1. Go to Configure > Deploy APs. Here you will be prompted to enter the FortiCloud key, which can be found on
the same label as the FortiAP unit's serial number, and select Submit.

If you have a FortiAPmodel that does not include a FortiCloud key, you can still add
the device to the network. To learn how, see the FortiCloud-managed FortiAPWiFi
without a key configuration.

2. In Set Platform Profiles, select the platform profile you created earlier and select Next.
3. Follow the rest of the deployment wizard. Select Submitwhen completed.
You will now be able to connect to the wireless network and browse the Internet. On the FortiCloud website, go to
Monitor > Reportwhere you can view monitoring information such as Traffic by Period, Client Count by
Period, and more.

FortiCloud-managed FortiAP WiFi without a key
You can manage your FortiAP-based wireless network with FortiCloud even if your FortiAP has no FortiCloud key.

For this example, you will need to have already pre-configured your FortiAP unit with your FortiCloud account
credentials. For more information on how to do this, or if your FortiAP has a FortiCloud key (on the serial number
label), see the FortiCloud-managed FortiAPWiFi configuration.

You can register for a free FortiCloud account at www.forticloud.com.

To create the WiFi network without a FortiCloud key, you must:
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l Configure the FortiAP unit
l Add the FortiAP unit to your FortiCloud account
l Configure the FortiAP

Configuring the FortiAP unit

You need to connect and configure the FortiAP unit through the web-based manager of the FortiGate.

To configure the FortiAP unit - web-based manager

1. Connect your computer to the FortiAP Ethernet port. The FortiAP’s default IP address is 192.168.1.2. The
computer should have an address on the same subnet, 192.168.1.3 for example.

2. Using a browser, log in to the FortiAP as admin. Leave the password field empty.
3. InWTP-Configuration, select FortiCloud and enter your FortiCloud credentials. Select Apply.

The FortiAP is now ready to connect to FortiCloud via the Internet.

Adding the FortiAP unit to your FortiCloud account

The FortiAPmust be added to the FortiCloud account that has a WiFi network already configured for it.

For an example of creating a WiFi network on FortiCloud, see FortiCloud-managed FortiAPWiFi on page 1526.

To add the FortiAP to FortiCloud

1. Connect the FortiAP Ethernet cable to a network that connects to the Internet.
Restore your computer to its normal network configuration and log on to FortiCloud.

2. From the Home screen, go to Inventory > AP Inventory. Your FortiAP should be listed.
3. Then go back to the Home screen, select your AP network, and go to Deploy APs.
4. Select your listed FortiAP and select Next.
5. Make sure your platform profile is selected from the dropdown menu, and select Next.
6. In Preview, select Deploy.

The device will now appear listed underAccess Points.

You will now be able to connect to the wireless network and browse the Internet. On the FortiCloud website, go to
Monitor > Reportwhere you can view monitoring information such as Traffic by Period, Client Count by
Period, and more.
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Using a FortiWiFi unit as a client

A FortiWiFi unit by default operates as a wireless access point. But a FortiWiFi unit can also operate as a wireless
client, connecting the FortiGate unit to another wireless network.

Use of client mode
In client mode, the FortiWiFi unit connects to a remote WiFi access point to access other networks or the
Internet. This is most useful when the FortiWiFi unit is in a location that does not have a wired infrastructure.

For example, in a warehouse where shipping and receiving are on opposite sides of the building, running cables
might not be an option due to the warehouse environment. The FortiWiFi unit can support wired users using its
Ethernet ports and can connect to another access point wirelessly as a client. This connects the wired users to the
network using the 802.11 WiFi standard as a backbone.

Note that in client mode the FortiWiFi unit cannot operate as an AP. WiFi clients cannot see or connect to the
FortiWifi unit in Client mode.
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FortiWiFi unit in Client mode

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1530



Using a FortiWiFi unit as a client

Configuring client mode
To set up the FortiAP unit as a WiFi client, you must use the CLI. Before you do this, be sure to remove any AP
WiFi configurations such as SSIDs, DHCP servers, policies, and so on.

To configure wireless client mode

1. Change the WiFi mode to client.
In the CLI, enter the following commands:

config system global
set wireless-mode client

end

Respond “y” when asked if you want to continue. The FortiWiFi unit will reboot.

2. Configure the WiFi interface settings.
For example, to configure the client for WPA-Personal authentication on the our_wifi SSID with passphrase
justforus, enter the following in the CLI:

config system interface
edit wifi

set mode dhcp
config wifi-networks

edit 0
set wifi-ssid our_wifi
set wifi-security wpa-personal
set wifi-passphrase "justforus"

end
end

The WiFi interface client_wifi will receive an IP address using DHCP.

3. Configure a wifi to port1 policy.
You can use either CLI or web-based manager to do this. The important settings are:

Incoming Interface (srcintf) wifi

Source Address (srcaddr) all

Outgoing Interface (dstintf) port1

Destination Address
(dstaddr)

all

Schedule always

Service ALL

Action ACCEPT

Enable NAT Selected

Controlled AP selection support in FWF client mode

Use the following CLI commands to provide a more controlled AP selection method (supported in FortiWiFi client
mode).
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Syntax

config system interface
edit {name}

set wifi-ap-band {any | 5g-preferred | 5g-only}
next

end

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1532



Support for location-based services

FortiOS supports location-based services by collecting information about WiFi devices near FortiGate-managed
access points, even if the devices don’t associate with the network.

Overview
WiFi devices broadcast packets as they search for available networks. The FortiGate WiFi controller can collect
information about the interval, duration, and signal strength of these packets. The Euclid Analytics service uses
this information to track the movements of the device owner. A typical application of this technology is to analyze
shopper behavior in a shopping center. Which stores do people walk past? Which window displays do they stop to
look at? Which stores do they enter and how long do they spend there? The shoppers are not personally
identified, each is known only by the MAC address of their WiFi device.

After enabling location tracking on the FortiGate unit, you can confirm that the feature is working by using a
specialized diagnostic command to view the raw tracking data. The Euclid Analytics service obtains the same
data in its proprietary format using a JSON inquiry through the FortiGate unit’s web-based manager interface.

Configuring location tracking
You can enable location tracking in any FortiAP profile, using the CLI. Location tracking is part of location-based
services. Set the station-locate field to enable. For example:

config wireless-controller wtp-profile
edit "FAP220B-locate"

set ap-country US
config platform

set type 220B
end
config lbs

set station-locate enable
end

end

Automatic deletion of outdated presence data

The FortiGate generates a log entry only the first time that station-locate detects a mobile client. No log is
generated for clients that have been detected before. To log repeat client visits, previous station presence data
must be deleted (flushed). The sta-locate-timer can flush this data periodically. The default period is 1800
seconds (30 minutes). The timer can be set to any value between 1 and 86400 seconds (24 hours). A setting of 0
disables the flush, meaning a client is logged only on the very first visit.

The timer is one of the wireless controller timers and it can be set in the CLI. For example:

config wireless-controller timers
set sta-locate-timer 1800

end

The sta-locate-timer should not be set to less than the sta-capability-timer (default 30 seconds) because that
could cause duplicate logs to be generated.
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FortiPresence push REST API

When the FortiGate is located on a private IP network, the FortiPresence server cannot poll the FortiGate for
information. Instead, the FortiGate must be configured to push the information to the FortiPresence server.

Enter the following command:

config wireless-controller wtp-profile
edit "FP223B-GuestWiFi"

config lbs
set fortipresence {enable | disable}
set fortipresence-server <ip-address> Default is 3000.
set fortipresence-port <port>
set fortipresence-secret <password>
set fortipresence-project <name>
set fortipresence-frequency <5-65535> Default is 30.
set fortipresence-rogue {enable | disable} Enable/disable reporting of Rogue APs.
set fortipresence-unassoc {enable | disable} Enable/disable reporting of unassociated

devices.
end

end

Viewing device location data on the FortiGate unit
You can use the FortiGate CLI to list located devices. This is mainly useful to confirm that the location data
feature is working, You can also reset device location data.

To list located devices

diag wireless-controller wlac -c sta-locate

To reset device location data

diag wireless-controller wlac -c sta-locate-reset

Example output

The following output shows data for three WiFi devices.

FWF60C3G11004319 # diagnose wireless-controller wlac -c sta-locate
sta_mac vfid rid base_mac freq_lst frm_cnt frm_fst frm_last intv_sum intv2_sum intv3_

sum intv_min intv_max signal_sum signal2_sum signal3_sum sig_min sig_max sig_fst
sig_last ap

00:0b:6b:22:82:61 0
FAP22B3U11005354 0 0 00:09:0f:f1:bb:e4 5745 257 708 56 651 1836 6441 0 12 -21832

1855438 -157758796 -88 -81 -84 -88 0

00:db:df:24:1a:67 0
FAP22B3U11005354 0 0 00:09:0f:f1:bb:e4 5745 42 1666 41 1625 97210 5831613 0 60 -3608

310072 -26658680 -90 -83 -85 -89 0

10:68:3f:50:22:29 0
FAP22B3U11005354 0 0 00:09:0f:f1:bb:e4 5745 102 1623 58 1565 94136 5664566 0 60 -8025

631703 -49751433 -84 -75 -78 -79 0
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The output for each device appears on two lines. The first line contains only the device MAC address and the
VLAN ID. The second line begins with the ID (serial number) of the FortiWiFi or FortiAP unit that detected the
device, the AP’s MAC address, and then the fields that the Euclid service uses. Because of its length, this line
wraps around and displays as multiple lines.
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In the following section, you will learn basic troubleshooting techniques for a secure Fortinet wireless LAN
including:

l strategies for troubleshooting Fortinet wireless devices
l how to avoid common misconfigurations
l solutions to connectivity issues
l capturing and analyzing wireless traffic
l wireless debug commands

The goal of this document is to provide you with practical knowledge that you can use to troubleshoot the FortiOS
wireless controller and FortiAP devices. This includes how to use tools and apply CLI commands for maintenance
and troubleshooting of your wireless network infrastructure, analyze problems per OSI layer, explore diagnostics
for commissioning issues regarding at-client and access point connectivity problems, and understand the packet
sniffer technique as a strong troubleshooting tool.

The content is divided as follows:

FortiAP shell command through CAPWAP control tunnel
Very often, the FortiAP in the field is behind a NAT device, and access to the FortiAP through Telnet or SSH is not
available. As a troubleshooting enhancement, this feature allows an AP shell command up to 127-bytes sent to
the FAP, and FAPwill run this command, and return the results to the controller using the CAPWAP tunnel.

The maximum output from a command is limited to 4M, and the default output size is set to 32K.

The FortiAP will only report running results to the controller after the command is finished. If a new command is
sent to the AP before the previous command is finished, the previous command will be canceled.

Enter the following:

diag w-c wlac wtpcmd wtp_ip wtp_port cmd [cmd-to-ap] cmd: run,show,showhex,clr,r&h,r&sh

l cmd-to-ap: any shell commands, but AP will not report results until the command is finished on the AP
l run: controller sends the ap-cmd to the FAP to run
l show: show current results reported by the AP in text
l showhex: show current results reported by the AP in hex
l clr: clear reported results
l r&s: run/show
l r&sh: run/showhex

Signal strength issues
Poor signal strength is possibly the most common customer complaint. Below you will learn where to begin
identifying and troubleshooting poor signal strength, and learn what information you can obtain from the
customer to help resolve signal strength issues.
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Asymmetric power issue

Asymmetric power issues are a typical problem. Wireless is two-way communication; high power access points
(APs) can usually transmit a long distance, however, the client's ability to transmit is usually not equal to that of
the AP and, as such, cannot return transmission if the distance is too far.

Measuring signal strength in both directions

To solve an asymmetric power issue, measure the signal strength in both directions. APs usually have enough
power to transmit long distances, but sometimes battery-powered clients have a reply signal that has less power,
and therefore the AP cannot detect their signal.

It is recommended that you match the transmission power of the AP to the least powerful wireless client—around
10 decibels per milliwatt (dBm) for iPhones and 14dBm for most laptops.

Even if the signal is strong enough, other devices may be emitting radiation as well, causing interference. To
identify the difference, read the client Rx strength from the FortiGate GUI (underMonitor > WiFi Client
Monitor) or CLI.

The Signal Strength/Noise value provides the received signal strength indicator (RSSI) of the wireless client.
For example, A value of -85dBm to -95dBm is equal to about 10dB levels; this is not a desirable signal strength.
In the following screenshot, one of the clients is at 18dB, which is getting close to the perimeter of its range.

The Signal Strength/Noise value received from the FortiAP by clients, and vice versa,
should be within the range of -20dBm to -65dBm.

You can also confirm the transmission (Tx) power of the controller on the AP profile (wtp-profile) and the
FortiAP (iwconfig), and check the power management (auto-Tx) options.

Controller configured transmitting power - CLI:

config wireless-controller wtp-profile
config <radio>

show
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(the following output is limited to power levels)
auto-power-level : enable
auto-power-high : 17
auto-power-low : 10

Actual FortiAP transmitting power - CLI:

iwconfig wlan00

Result:
wlan00 IEEE 802.11ng ESSID:"signal-check"
Mode:Master Frequency:2.412 GHz Access Point:<MAC add>
Bit Rate:130 Mb/s Tx-Power=28 dBm

Using FortiPlanner PRO with a site survey

The most thorough method to solve signal strength issues is to perform a site survey. To this end, Fortinet offers
the FortiPlanner, downloadable at http://www.fortinet.com/resource_center/product_downloads.html.

Sample depiction of a site survey using FortiPlanner

The site survey provides you with optimal placement for your APs based on the variables in your environment.
You must provide the site survey detailed information including a floor plan (to scale), structural materials, and
more. It will allow you to place the APs on the map and adjust the radio bands and power levels while providing
you with visual wireless coverage.

Below is a list of mechanisms for gathering further information on the client for Rx strength. The goal is to see
how well the client is receiving the signal from the AP. You can also verify FortiAP signal strength on the client
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using WiFi client utilities, or third party utilities such as InSSIDer or MetaGeek Chanalyzer. You can get similar
tools from the app stores on Android and iOS devices.

l Professional Site Survey software (Ekahau, Airmagnet survey Pro, FortiPlanner)
l InSSIDer
l OnWindows: “netsh wlan show networks mode=bssid” (look for the BSSID, it's in % not in dBm!)
l On MacOS: Use the “airport” command:

“/System/Library/PrivateFrameworks/Apple80211.framework/Versions/A/Resources/airport” airport –s |
grep <the_bssid> (live scan each time)

l On Droid: WiFiFoFum

Frequency interference

If the wireless signal seems to be strong but then periodically drops, this may be a symptom of frequency
interference. Frequency interference is when another device also emits radio frequency using the same channel,
co-channel, or adjacent channel, thereby overpowering or corrputing your signal. This is a common problem on a
2.4GHz network.

There are two types of interference: coherent and non-coherent.

l Coherent interference: a result of another device using the same channel as your AP, or poor planning of a
wireless infrastructure (perhaps the other nearby APs are using the same channel or the signal strength is too high).

l Non-coherent interference: a result of other radio signals such as bluetooth, microwave, cordless phone, or (as in
medical environments) x-ray machines.

Most common and simple solution for frequency interference is to change your operation channel. Typically, the
channel can be set from 1 to 11 for the broadcast frequency, although you should always use channels 1, 6, and
11 on the 2.4GHz band.

Another solution, if it's appropriate for your location, is to use the 5GHz band instead.

MetaGeek Chanalyzer

You can perform a site survey using spectrum analysis at various points in your environment looking for signal
versus interference/noise. MetaGeek Chanalyzer is an example of a third party utility which shows a noise
threshold.

Note that a signal of -95dBm or less will be ignored by Fortinet wireless adapters.
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Throughput issues
Sometimes communication issues can be caused by low performance.

Testing the link

You can identify delays or lost packets by sending ping packets from your wireless client. If there is more than
10ms of delay, there may be a problem with your wireless deployment, such as:

l a weak transmit signal from the client (the host does not reach the AP)
l the AP utilization is too high (your AP could be saturated with connected clients)
l interference (third party signal could degrade your AP or client's ability to detect signals between them)
l weak transmit power from the AP (the AP does not reach the host) -- not common in a properly deployed network,

unless the client is too far away

Keep in mind that water will also cause a reduction in radio signal strength for those making use out of outdoor
APs or wireless on a boat.

Performance testing

If the FortiAP gives bad throughput to the client, the link may drop. The throughput or performance can be
measured on your smartphone with third party applications tool such as iPerf and jPerf.

Measuring file transfer speed

Another way to get a sense of your throughput issues is to measure the speed of a file transfer on your network.
Create a test file at a specific size and measure the speed at which Windowsmeasures the transfer. The
command below will create a 50MB file.

l fsutil file createnew test.txt 52428800

The following image shows a network transfer speed of just over 24Mbps. The theoretical speed of 802.11g is
54Mbps, which is what this client is using. A wireless client is never likely to see the theoretical speed.
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TKIP limitation

If you find that throughput is a problem, avoid WPA security encrypted with Temporal Key Integrity Protocol
(TKIP) as it supports communications only at 54Mbps. Use WPA-2 AES instead.

Speeds are very much based on what the client computer can handle as well. The maximum client connection
rate of 130Mbps is for 2.4GHz on a 2x2, or 300Mbps for 5Ghz on a 2x2 (using shortguard and channel bonding
enabled).

If you want to get more than 54Mbps with 802.11n, do not use legacy TKIP, use CCMP instead. This is standard
for legacy compatibility.

Preventing IP fragmentation in CAPWAP

TKIP is not the only possible source of decreased throughput. When a wireless client sends jumbo frames using a
CAPWAP tunnel, it can result in data loss, jitter, and decreased throughput.

Using the following commands you can customize the uplink rates and downlink rates in the CAPWAP tunnel to
prevent fragmentation and avoid data loss.

config wireless-controller wtp
edit new-wtp

set ip-fragment-preventing [tcp-mss-adjust | icmp-unreachable]
set tun-mtu-uplink [0 | 576 | 1500]
set tun-mtu-downlink [0 | 576 | 1500]

end
end

The default value is 0, however the recommended value will depend on the type of traffic. For example, IPsec in
tunnel mode has 52 bytes of overhead, so you might use 1400 or less for uplink and downlink.

Slowness in the DTLS response

It's important to know all the elements involved in the CAPWAP association:

l Request
l Response
l DTLS
l Join
l Configuration

All of these are bidirectional. So if the DTLS response is slow, this might be the result of a configuration error.
This issue can also be caused by a certificate during discovery response. You can read more about this in RFC
5416.

Connection issues
If the client has a connectivity issue that is not due to signal strength, the solution varies by the symptom.

Client connection issues

1. If client is unable to connect to FortiAP:
l Make sure the client’s security and authentication settings match with FortiAP and check the certificates as

well.
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l Try upgrading the Wi-Fi adapter driver and FortiGate/FortiAP firmware.
l If other clients can connect, it could be interoperability; run debug commands and sniffer packets.
l Look for rogue suppression by sniffing the wireless traffic and looking for the disconnect in the output (using the

AP or wireless packet sniffer).
l Try changing the IEEE protocol from 802.11n to 802.11bg or 802.11a only.

2. If the client drops and reconnects:
l The client might be de-authenticating periodically. Check the sleep mode on the client.
l The issue could be related to power-saver settings. The client may need to udpate drivers.
l The issue could also be caused by flapping between APs. Check the roaming sensitivity settings on the client or

the preferred wireless network settings on the client—if another WiFi network is available, the client may
connect to it if it is a preferred network. Also, check the DHCP configuration as it may be an IP conflict.

3. If the client drops and never connects:
l It could have roamed to another SSID, so check the standby and sleep modes.
l You may need to bring the interface up and down.

4. If the client connects, but no IP address is acquired by the client:
l Check the DHCP configuration and the network.
l It could be a broadcast issue, so check the WEP encryption key and set a static IP address and VLANs.

Debug

You should also enable client debug on the controller for problematic clients to see the stage at which the client
fails to connect. Try to connect from the problematic client and run the following debug command, which allows
you to see the four-way handshake of the client association:

diagnose wireless-controller wlac sta_filter <client MAC address> 2

Example of a successful client connection:

The following is a sample debug output for the above command, with successful association/DHCP phases and
PSK key exchange (identified in color):

FG600B3909600253 #
91155.197 <ih> IEEE 802.11 mgmt::assoc_req <== 30:46:9a:f9:fa:34 vap signal-check rId 0

wId 0 00:09:0f:f3:20:45
91155.197 <ih> IEEE 802.11 mgmt::assoc_resp ==> 30:46:9a:f9:fa:34 vap signal-check rId 0

wId 0 00:09:0f:f3:20:45 resp 0
91155.197 <cc> STA_CFG_REQ(15) sta 30:46:9a:f9:fa:34 add ==> ws (0-192.168.35.1:5246) rId

0 wId 0
91155.197 <dc> STA add 30:46:9a:f9:fa:34 vap signal-check ws (0-192.168.35.1:5246) rId 0

wId 0 bssid 00:09:0f:f3:20:45 NON-AUTH
91155.197 <cc> STA add 30:46:9a:f9:fa:34 vap signal-check ws (0-192.168.35.1:5246) rId 0

wId 0 00:09:0f:f3:20:45 sec WPA2 AUTO auth 0
91155.199 <cc> STA_CFG_RESP(15) 30:46:9a:f9:fa:34 <== ws (0-192.168.35.1:5246) rc 0

(Success)
91155.199 <eh> send 1/4 msg of 4-Way Handshake
91155.199 <eh> send IEEE 802.1X ver=1 type=3 (EAPOL_KEY) data len=95 replay cnt 1
91155.199 <eh> IEEE 802.1X (EAPOL 99B) ==> 30:46:9a:f9:fa:34 ws (0-192.168.35.1:5246) rId

0 wId 0 00:09:0f:f3:20:45
91155.217 <eh> IEEE 802.1X (EAPOL 121B) <== 30:46:9a:f9:fa:34 ws (0-192.168.35.1:5246) rId

0 wId 0 00:09:0f:f3:20:45
91155.217 <eh> recv IEEE 802.1X ver=1 type=3 (EAPOL_KEY) data len=117
91155.217 <eh> recv EAPOL-Key 2/4 Pairwise replay cnt 1
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91155.218 <eh> send 3/4 msg of 4-Way Handshake
91155.218 <eh> send IEEE 802.1X ver=1 type=3 (EAPOL_KEY) data len=175 replay cnt 2
91155.218 <eh> IEEE 802.1X (EAPOL 179B) ==> 30:46:9a:f9:fa:34 ws (0-192.168.35.1:5246) rId

0 wId 0 00:09:0f:f3:20:45
91155.223 <eh> IEEE 802.1X (EAPOL 99B) <== 30:46:9a:f9:fa:34 ws (0-192.168.35.1:5246) rId

0 wId 0 00:09:0f:f3:20:45
91155.223 <eh> recv IEEE 802.1X ver=1 type=3 (EAPOL_KEY) data len=95
91155.223 <eh> recv EAPOL-Key 4/4 Pairwise replay cnt 2
91155.223 <dc> STA chg 30:46:9a:f9:fa:34 vap signal-check ws (0-192.168.35.1:5246) rId 0

wId 0 bssid 00:09:0f:f3:20:45 AUTH
91155.224 <cc> STA chg 30:46:9a:f9:fa:34 vap signal-check ws (0-192.168.35.1:5246) rId 0

wId 0 00:09:0f:f3:20:45 sec WPA2 AUTO auth 1
91155.224 <cc> STA_CFG_REQ(16) sta 30:46:9a:f9:fa:34 add key (len=16) ==> ws (0-

192.168.35.1:5246) rId 0 wId 0
91155.226 <cc> STA_CFG_RESP(16) 30:46:9a:f9:fa:34 <== ws (0-192.168.35.1:5246) rc 0

(Success)
91155.226 <eh> ***pairwise key handshake completed*** (RSN)
91155.257 <dc> DHCP Request server 0.0.0.0 <== host ADMINFO-FD4I2HK mac 30:46:9a:f9:fa:34

ip 172.16.1.16
91155.258 <dc> DHCP Ack server 172.16.1.1 ==> host mac 30:46:9a:f9:fa:34 ip 172.16.1.16

mask 255.255.255.0 gw 172.16.1.1

where:

l orange represents the association phase,
l blue represents the PSK exchange,
l and green represents the DHCP phase.

It is important to note the messages for a correct association phase, four-way handshake, and DHCP phase.

Checking WiFi password

Admins can view plain text passwords (captive-portal-radius-secret and passphrase) under
config wireless-controller vap.

Note that security must be set as a WPA-personal setting.

FortiAP connection issues

Clients are not the only device that can fail to connect, of course. A communication problem could arise from the
FortiAP.

Some examples include:

l The FortiAP is not connecting to the wireless controller.
l One FortiAP intermittently disconnects and re-connects.
l All FortiAPs intermittently disconnect and re-connect.
l Unable to Telnet to FortiAP from controller/administrator workstation.

In the above cases:

l Check networking on the distribution system for all related FortiAPs.
l Check the authorization status of managed APs from the wireless controller.
l Restart the cw_acd process (Note: All APs will drop if you do this, and you may be troubleshooting just one AP).
l Check the controller crash log for any wireless controller daemon crash using the following command:

diagnose debug crashlog read
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Debug

For a quick assessment of the association communication between the controller and the FortiAP, run the
following sniffer command to see if you can verify that the AP is communicating to the controller by identifying the
CAPWAP communication:

diagnose sniff packet <interface_name> “port 5246” 4

If you do not see this communication, then you can investigate the network or the settings on the AP to see why it
is not reaching the controller.

The following command allows you to collect verbose output from the sniff that can be converted to a PCAP and
viewed in Wireshark.

diagnose sniff packet <interface_name> “port 5246” 6 o l

The image below shows the beginning of the AP's association to the controller. You can see the discovery
Request and Response at the top.

Throughout debugging it is recommended to:

l Enable Telnet login to the FortiAP device so that you can log in and issue local debugging commands:

config wireless-controller wtp
edit "<FortiAP_serial_number>"

set override-allowaccess {disable|enable}
set allowaccess {telnet | http | https | ssh}

end

l Try to connect to the wireless controller from the problematic FortiAP to verify routes exist.

l Enable wtp (FortiAP) debugging on the wireless controller for problematic FortiAPs to determine the point at which
the FortiAP fails to connect:

diag wireless-controller wlac wtp_filter FP112B3X13000193 0-192.168.6.8:5246 2
(replace the serial number and IP address of the FortiAP)
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di de console timestamp en
di de application cw_acd 0x7ff
di de en

Example of a successful AP and controller association:

The previous debug command provides similar output to the sample debug message below for a successful
association between the FortiAP and the wireless controller. This includes the elements of the CAPWAP protocol;
the Request, Response, DTLS, Join, and Configuration (identified in color). All of these are bi-directional, so if
the DTLS response is slow, it may be an example of a configuration error.

56704.575 <msg> DISCOVERY_REQ (12) <== ws (0-192.168.35.1:5246)
56704.575 <msg> DISCOVERY_RESP (12) ==> ws (0-192.168.35.1:5246)
56707.575 <msg> DISCOVERY_REQ (13) <== ws (0-192.168.35.1:5246)
56707.575 <msg> DISCOVERY_RESP (13) ==> ws (0-192.168.35.1:5246)
56709.577 <aev> - CWAE_INIT_COMPLETE ws (0-192.168.35.1:5246)
56709.577 <aev> - CWAE_LISTENER_THREAD_READY ws (0-192.168.35.1:5246)
56709.577 <fsm> old CWAS_START(0) ev CWAE_INIT_COMPLETE(0) new CWAS_IDLE(1)
56709.577 <fsm> old CWAS_IDLE(1) ev CWAE_LISTENER_THREAD_READY(1) new CWAS_DTLS_SETUP(4)
56709.623 <aev> - CWAE_DTLS_PEER_ID_RECV ws (0-192.168.35.1:5246)
56709.623 <aev> - CWAE_DTLS_AUTH_PASS ws (0-192.168.35.1:5246)
56709.623 <aev> - CWAE_DTLS_ESTABLISHED ws (0-192.168.35.1:5246)
56709.623 <fsm> old CWAS_DTLS_SETUP(4) ev CWAE_DTLS_PEER_ID_RECV(7) new CWAS_DTLS_

AUTHORIZE(2)
56709.623 <fsm> old CWAS_DTLS_AUTHORIZE(2) ev CWAE_DTLS_AUTH_PASS(3) new CWAS_DTLS_CONN(5)
56709.623 <fsm> old CWAS_DTLS_CONN(5) ev CWAE_DTLS_ESTABLISHED(8) new CWAS_JOIN(7)
56709.625 <msg> JOIN_REQ (14) <== ws (0-192.168.35.1:5246)
56709.625 <aev> - CWAE_JOIN_REQ_RECV ws (0-192.168.35.1:5246)
56709.626 <fsm> old CWAS_JOIN(7) ev CWAE_JOIN_REQ_RECV(12) new CWAS_JOIN(7)
56709.629 <msg> CFG_STATUS (15) <== ws (0-192.168.35.1:5246)
56709.629 <aev> - CWAE_CFG_STATUS_REQ ws (0-192.168.35.1:5246)
56709.629 <fsm> old CWAS_JOIN(7) ev CWAE_CFG_STATUS_REQ(13) new CWAS_CONFIG(8)
56710.178 <msg> CHG_STATE_EVENT_REQ (16) <== ws (0-192.168.35.1:5246)
56710.178 <aev> - CWAE_CHG_STATE_EVENT_REQ_RECV ws (0-192.168.35.1:5246)
56710.178 <fsm> old CWAS_CONFIG(8) ev CWAE_CHG_STATE_EVENT_REQ_RECV(23) new CWAS_DATA_

CHAN_SETUP(10)
56710.220 <aev> - CWAE_DATA_CHAN_CONNECTED ws (0-192.168.35.1:5246)
56710.220 <msg> DATA_CHAN_KEEP_ALIVE <== ws (0-192.168.35.1:5246)
56710.220 <aev> - CWAE_DATA_CHAN_KEEP_ALIVE_RECV ws (0-192.168.35.1:5246)
56710.220 <msg> DATA_CHAN_KEEP_ALIVE ==> ws (0-192.168.35.1:5246)
56710.220 <fsm> old CWAS_DATA_CHAN_SETUP(10) ev CWAE_DATA_CHAN_CONNECTED(32) new CWAS_

DATA_CHECK(11)
56710.220 <aev> - CWAE_DATA_CHAN_VERIFIED ws (0-192.168.35.1:5246)
56710.220 <fsm> old CWAS_DATA_CHECK(11) ev CWAE_DATA_CHAN_KEEP_ALIVE_RECV(35) new CWAS_

DATA_CHECK(11)
56710.220 <fsm> old CWAS_DATA_CHECK(11) ev CWAE_DATA_CHAN_VERIFIED(36) new CWAS_RUN(12)
56710.228 <msg> WTP_EVENT_REQ (17) <== ws (0-192.168.35.1:5246)
56710.228 <aev> - CWAE_WTP_EVENT_REQ_RECV ws (0-192.168.35.1:5246)
56710.228 <fsm> old CWAS_RUN(12) ev CWAE_WTP_EVENT_REQ_RECV(42) new CWAS_RUN(12)
56710.230 <msg> CFG_UPDATE_RESP (1) <== ws (0-192.168.35.1:5246) rc 0 (Success)
56710.230 <aev> - CWAE_CFG_UPDATE_RESP_RECV ws (0-192.168.35.1:5246)
56710.230 <msg> WTP_EVENT_REQ (18) <== ws (0-192.168.35.1:5246)
56710.230 <aev> - CWAE_WTP_EVENT_REQ_RECV ws (0-192.168.35.1:5246)
56710.230 <fsm> old CWAS_RUN(12) ev CWAE_CFG_UPDATE_RESP_RECV(37) new CWAS_RUN(12)
56710.230 <fsm> old CWAS_RUN(12) ev CWAE_WTP_EVENT_REQ_RECV(42) new CWAS_RUN(12)
56710.231 <msg> WTP_EVENT_REQ (19) <== ws (0-192.168.35.1:5246)
56710.231 <aev> - CWAE_WTP_EVENT_REQ_RECV ws (0-192.168.35.1:5246)
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56710.231 <fsm> old CWAS_RUN(12) ev CWAE_WTP_EVENT_REQ_RECV(42) new CWAS_RUN(12)
56710.232 <msg> CFG_UPDATE_RESP (2) <== ws (0-192.168.35.1:5246) rc 0 (Success)
56710.232 <aev> - CWAE_CFG_UPDATE_RESP_RECV ws (0-192.168.35.1:5246)
56710.232 <fsm> old CWAS_RUN(12) ev CWAE_CFG_UPDATE_RESP_RECV(37) new CWAS_RUN(12)
56710.233 <msg> WTP_EVENT_REQ (20) <== ws (0-192.168.35.1:5246)
56710.233 <aev> - CWAE_WTP_EVENT_REQ_RECV ws (0-192.168.35.1:5246)
56710.233 <fsm> old CWAS_RUN(12) ev CWAE_WTP_EVENT_REQ_RECV(42) new CWAS_RUN(12)
56712.253 < . > AC (2) -> WTP (0-192.168.35.1:5246) State: CWAS_RUN (12) accept 3 live 3

dbg 00000000 pkts 12493 0
56715.253 < . > AC (2) -> WTP (0-192.168.35.1:5246) State: CWAS_RUN (12) accept 3 live 6

dbg 00000000 pkts 12493 0
56718.253 < . > AC (2) -> WTP (0-192.168.35.1:5246) State: CWAS_RUN (12) accept 3 live 9

dbg 00000000 pkts 12493 0
56719.253 <aev> - CWAE_AC_ECHO_INTV_TMR_EXPIRE ws (0-192.168.35.1:5246)
56719.253 <fsm> old CWAS_RUN(12) ev CWAE_AC_ECHO_INTV_TMR_EXPIRE(39) new CWAS_RUN(12)
56719.576 <msg> ECHO_REQ (21) <== ws (0-192.168.35.1:5246)
56719.576 <aev> - CWAE_ECHO_REQ_RECV ws (0-192.168.35.1:5246)
56719.577 <fsm> old CWAS_RUN(12) ev CWAE_ECHO_REQ_RECV(27) new CWAS_RUN(12)

where:

l orange represents the Discovery phase,
l blue indicates that the control channels have been established using DTLS,
l green represents the access point Discovery and Join phase,
l purple represents the Clear Text channel,
l and pink indicates that the FortiAP successfully connected to the wireless controller.

General problems
Not all WiFi problems are related to signal strength, interference, or misconfiguration. The following OSI model
identifies some of the more common issues per layer.

Best practices for troubleshooting vary depending on the affected layer (see below).
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Common sources of wireless issues

Best practices for Layer 1

Common physical layer issues include:

l Weak received signal,
l WiFi capability: 802.11b, 1x1, 2x2,
l Co-channel WiFi interference,
l Side band WiFi interference,
l Non 802.11 noise (microwave ovens...).

To avoid physical layer issues:

l Determine RST (Receiver Sensitivity Threshold) for your device, or use -70dBm as a rule of thumb.
l Match AP TX output power to the client TX output power.

l Note: iPhone TX power is only 10dBm.
l Use DFS (Dynamic Frequency Selection) for high performance data 20/40 MHz.
l Use 5GHz UNII-1 & 3 (Non-DFS) bands with static channel assignment for latency-sensitive applications.
l Do not use 40MHz channels in 2.4 GHz band (channel bonding is not allowed in FortiOS).

Best practices for Layer 2

Common data link (MAC) layer issues include:

l Too many clients on a single channel (CSMA/CA) backoff,
l Too many high-priority traffic clients (WMM),
l Incorrect password or encryption settings,
l Too many beacons (in dense installs).

To avoid data link layer issues:
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l Only use CCMP/AES (WPA2) encryption (not TKIP).
l In high density deployments, turn off SSID broadcast or turn down SSID rates. Review and possibly reduce the

beacon interval.
l Determine the best cell size for applications:

l For few users and low bandwidth latency sensitive applications, use high transmit power to create larger cells.
l For high performance/high capacity installations, use lower transmit power to create smaller cells (set

FortiPlanner at 10dBm TX power), but bear in mind that this will require more roaming.

Cells and co-channel interference

In high density deployments, multiple APs are used, and each one services an area called a cell. However, these
cells can cause interference with each other. This is a common problem. The radio signal from one AP interferes
with, or cancels out, the radio signal from another AP.

In the following diagram, note the interference zone created by one radio, causing interference on its
neighbouring APs.

The interference zone can be twice the radius of the signal, and the signal at its edge can be -67dBm.

Reducing co-channel interference

For best results, use a 'honeycomb' pattern as a deployment strategy. The idea is to stagger repeated channels
furthest from each other to avoid interference.
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Best practices for Layer 3 and above

For TCP/IP layers and above, a common source of latency, or slowness in the wireless traffic, is too many
broadcasts or multicasts. These types of issues can result from non-business and/or unwanted traffic.

To resolve issues at the TCP/IP layer and above:

l Identify business-critical applications.
l Use Application Control, Web Filtering, Traffic Shaping, and QoS to prioritize applications.

l Identify unwanted traffic, high-bandwidth web-related traffic, and use Security Profiles.
l Use the traffic shaper on a policy to rate-limit this traffic.

These configurations are performed directly on the FortiGate.

Packet sniffer
Capturing the traffic between the controller and the FortiAP can help you identify most FortiAP and client
connection issues.

This section describes the following recommended packet sniffing techniques:

l CAPWAP packet sniffer
l Wireless traffic packet sniffer

CAPWAP packet sniffer

The first recommended technique consists of sniffing the CAPWAP traffic.

l Enable plain control on the controller and on the FortiAP to capture clear control traffic on UDP port 5246.
l On the controller:

diagnose wireless-controller wlac plain-ctl <FortiAP_serial_number> 1

Result:
WTP 0-FortiAP2223X11000107 Plain Control: enabled
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l On the FortiAP:

cw_diag plain-ctl 1

Result:
Current Plain Control: enabled

Note that some issues are related to the keep-alive for control and data channel.

l Data traffic on UDP port 5247 is not encrypted. The data itself is encrypted by the wireless security mechanism.

Data traffic is helpful to troubleshoot most of the issues related to station association, EAP authentication,
WPA key exchange, roaming, and FortiAP configuration.

You can also set up a host or server to which you can forward the CAPWAP traffic:

1. Configure the host/server to which CAPWAP traffic is forwarded:
diagnose wireless-controller wlac sniff-cfg <Host_IP_address> 88888

Result:
Current Sniff Server: 192.168.25.41, 23352

2. Choose which traffic to capture, the interface to which the FortiAP is connected, and the FortiAP’s serial number:
diagnose wireless-controller wlac sniff <interface_name> <FortiAP_serial_number> 2

Result:
WTP 0-FortiAP2223X11000107 Sniff: intf port2 enabled (control and data message)

In the above syntax, the '2' captures the control and data message—'1' would capture only the control
message, and '0' would disable it.

3. Run Wireshark on the host/server to capture CAPWAP traffic from the controller.
l Decode the traffic as IP to check inner CAPWAP traffic.

Example CAPWAP packet capture

The following image shows an example of a CAPWAP packet capture, where you can see: the Layer 2 header;
the sniffed traffic encapsulated into Internet Protocol for transport; CAPWAP encapsulated into UDP for sniffer
purpose and encapsulated into IP; CAPWAP control traffic on UDP port 5246; and CAPWAP payload.
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Wireless traffic packet sniffer

The second recommended technique consists of sniffing the wireless traffic directly 'on the air' using your FortiAP.

Wireless traffic packet capture

Packet captures are useful for troubleshooting all wireless client related issues because you can verify data rate
and 802.11 parameters, such as radio capabilities, and determine issues with wireless signal strength,
interference, or congestion on the network.

A radio can only capture one frequency at a time; one of the radios is set to sniffer mode depending on the traffic
or channel required. You must use two FortiAPs to capture both frequencies at the same time.

l Set a radio on the FortiAP to monitor mode.

iwconfig wlan10

Result:
wlan10 IEEE 802.11na ESSID:""
Mode:Monitor Frequency:5.18 GHz Access Point: Not-Associated

l The capture file is stored under the temp directory aswl_sniff.pcap

/tmp/wl_sniff.cap

l Remember that the capture file is only stored temporarily. If you want to save it, upload it to a TFTP server
before rebooting or changing the radio settings.

l The command cp wl_sniff.cap newname.pcap allows you to rename the file.
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l Rather than TFTP the file, you can also log in to the AP and retrive the file via the web interface. Move the file
using the command: mv name /usr/www

You can verify the file was moved using the command cd/usr/www and then browsing to: <fortiAP_
IP>/filename

Syntax

The following syntax demonstrates how to set the radio to sniffer mode (configurable from the CLI only). Sniffer
mode provides options to filter for specific traffic to capture. Notice that you can determine the buffer size, which
channel to sniff, the AP's MAC address, and select if you want to sniff the beacons, probes, controls, and data
channels.

configure wireless-controller wtp-profile
edit <profile_name>

configure <radio>
set mode sniffer
set ap-sniffer-bufsize 32
set ap-sniffer-chan 1
set ap-sniffer-addr 00:00:00:00:00:00
set ap-sniffer-mgmt-beacon enable
set ap-sniffer-mgmt-probe enable
set ap-sniffer-mgmt-other enable
set ap-sniffer-ctl enable
set ap-sniffer-data enable

end
end

Once you've performed the previous CLI configuration, you'll be able to see the packet sniffer mode selected in
the GUI dashboard underWiFi & Switch Controller > FortiAP Profiles andWiFi & Switch Controller >
Managed FortiAPs. Bear in mind that if you change the mode from the GUI, you'll have to return to the CLI to
re-enable the Sniffer mode.

To disable the sniffer profile in the CLI, use the following commands:

config wireless-controller wtp-profile
edit <profile_name>

config <radio>
set ap-sniffer-mgmt-beacon disable
set ap-sniffer-mgmt-probe disable
set ap-sniffer-mgmt-other disable
set ap-sniffer-ctl disable
set ap-sniffer-data disable

end
end

If you change the radio mode before sending the file wl_sniff.cap to an external
TFTP, the file will be deleted and you will lose your packet capture.

Example AP packet capture

The following image shows an example of the AP packet capture. Note the capture header showing channel 36;
the beacon frame; the source, destination, and BSSID of the beacon frame; and the SSID of the beacon frame.
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Useful debugging commands
For a comprehensive list of useful debug options you can use the following help commands on the controller:

diagnose wireless-controller wlac help
(this command lists the options available that pertain to the wireless controller)

diagnose wireless-controller wlwtp help
(this command lists the options available that pertain to the AP)

Sample outputs

Syntax

diagnose wireless-controller wlac -c vap
(this command lists the information about the virtual access point, including its MAC address, the BSSID, its
SSID, the interface name, and the IP address of the APs that are broadcasting it)

Result:
bssid ssid intf vfid:ip-port rId wId
00:09:0f:d6:cb:12 Office Office ws (0-192.168.3.33:5246) 0 0
00:09:0f:e6:6b:12 Office Office  ws (0-192.168.1.61:5246) 0 0
06:0e:8e:27:dc:48 Office Office   ws (0-192.168.3.36:5246) 0 0
0a:09:0f:d6:cb:12 public publicAP ws (0-192.168.3.33:5246) 0 1
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Syntax

diagnose wireless-controller wlac -c darrp
(this command lists the information pertaining to the radio resource provisioning statistics, including the
AP serial number, the number of channels set to choose from, and the operation channel. Note that the 5GHz
band is not available on these APs listed)

Result:
wtp_id           rId base_mac          index nr_chan vfid 5G oper_chan age
FAP22A3U10600400 0   00:09:0f:d6:cb:12 0 3       0 No 1 87588
FW80CM3910601176 0 06:0e:8e:27:dc:48 1     3 0    No 6         822
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This chapter provides some reference information pertaining to wireless networks.
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FortiAP web-based manager
You can access the FortiAP unit’s built-in web-based manager. This is useful to adjust settings that are not
available through the FortiGate unit’s WiFi Controller. Logging into the FortiAP web-based manager is similar to
logging into the FortiGate web-based manager.

System Information

Status

The Status section provides information about the FortiAP unit.

You can:

l Select Change to change the Host Name.
l Select Update in Firmware Version to upload a new FortiAP firmware file from your computer.
l Select Change Password to change the administrator password.
l Select Backup to save the current FortiAP configuration as a file on your computer.
l Select Restore to load a configuration into your FortiAP unit from a file on your computer.

Network Configuration

Select DHCP or select Static and specify the IP address, netmask, and gateway IP address. Administrative
Access settings affect access after the FortiAP has been authorized. By default, HTTP access needed to access
the FortiAP web-based manager is enabled, but Telnet access is not enabled.

Connectivity

These settings determine how the FortiAP unit connects to the FortiGate WiFi controller.
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Uplink Ethernet - wired connection to the FortiGate unit (default)

Mesh - WiFi mesh connection

Ethernet with mesh backup support

Mesh AP SSID Enter the SSID of the mesh root. Default: fortinet.mesh.root

Mesh AP
Password

Enter password for the mesh SSID.

Ethernet Bridge
Bridge the mesh SSID to the FortiAP Ethernet port.

This is available only whe Uplink isMesh.

WTP Configuration

AC Discovery Type settings affect how the FortiAP unit discovers a FortiGate WiFi controller. By default, this is
set to Auto which causes the FortiAP unit to cycle through all of the discovery methods until successful. For more
information see Controller discovery methods.

AC Discovery
Type

Static, DHCP, DNS, Broadcast, Multicast, Auto

AC Control Port Default port is 5246.

AC IP Address 1
AC IP Address 2
AC IP Address 3

You enter up to three WiFi controller IP addresses for static discovery. Routing must
be properly configured in both directions.

AC Host Name 1
AC Host Name 2
AC Host Name 3

As an alternetive to AC IP addresses, you can enter their fully qualified domain names
(FQDNs).

AC Discovery
Multicast
Address

224.0.1.140

AC Discovery
DHCP Option
Code

When using DHCP discovery, you can configure the DHCP server to provide the
controller address. By default the FortiAP unit expects this in option 138.

AC Data Channel Security by default accepts either DTLS-encrypted or clear text data communication with the
WiFi controller. You can change this setting to require encryption or to use clear text only.

Wireless Information

The Wireless Information page provides current information about the operation of the radios and the type Uplink
in use.

1557 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Reference

Wireless radio channels

IEEE 802.11a/n channels

The following table lists the channels supported on FortiWiFi products that support the IEEE 802.11a and
802.11n wireless standards. 802.11a is available on FortiWiFi models 60B and higher. 802.11n is available on
FortiWiFi models 80CM and higher.

All channels are restricted to indoor usage except in the Americas, where both indoor and outdoor use is
permitted on channels 52 through 64 in the United States.

IEEE 802.11a/n (5-GHz Band) channel numbers

Channel number Frequency (MHz)
Regulatory Areas

Americas Europe Taiwan Singapore Japan

34 5170 •

36 5180 • • •

38 5190

40 5200 • • • •

42 5210

44 5220 • • • •

46 5230

48 5240 • • • •

149 5745 • • •

153 5765 • • •

157 5785 • • •

161 5805 • • •

165 5825 • •

IEEE 802.11b/g/n channel numbers

The following table lists IEEE 802.11b/g/n channels. All FortiWiFi units support 802.11b and 802.11g. Newer
models also support 802.11n.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1558



Reference

Mexico is included in the Americas regulatory domain. Channels 1 through 8 are for indoor use only. Channels 9
through 11 can be used indoors and outdoors. You must make sure that the channel number complies with the
regulatory standards of Mexico.

IEEE 802.11b/g/n (2.4-GHz Band) channel numbers

Channel number Frequency (MHz)
Regulatory Areas

Americas EMEA Israel Japan

1 2412 • • indoor •

2 2417 • • indoor •

3 2422 • • indoor •

4 2427 • • indoor •

5 2432 • • • •

6 2437 • • • •

7 2442 • • • •

8 2447 • • • •

9 2452 • • • •

10 2457 • • • •

11 2462 • • • •

12 2467 • • •

13 2472 • • •

14 2484 b only

View all Country & Regcodes/Regulatory Domains

The following CLI command can be entered to view a list of the Country & Regcodes/Regulatory Domains
supported by Fortinet:

cw_diag -c all-countries

Below is a table showing a sample of the list displayed by entering this command:

Country-code Region-code Domain ISO-name Name

0 A FCC3 & FCCA NA NO_COUNTRY_SET
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Country-code Region-code Domain ISO-name Name

8 W NULL1 &WORLD AL ALBANIA

12 W NULL1 &WORLD DZ ALGERIA

16 A FCC3 & FCCA AS AMERICAN SAMOA

... ... ... ... ...

WiFi event types

Event type Description

rogue-ap-detected A rogue AP has been detected (generic).

rogue-ap-off-air A rogue AP is no longer detected on the RF side.

rogue-ap-on-wire A rogue AP has been detected on wire side (connected to AP or controller L2
network).

rogue-ap-off-wire A rogue AP is no longer detected on wire.

rogue-ap-on-air A rogue AP has been detected on the RF side.

fake-ap-detected A rogue AP broadcasting on the same SSIDs that you have in your managed APs
has been detected.

fake-ap-on-air The above fake APwas detected on the RF side.

FortiAP CLI
The FortiAP CLI controls radio and network operation through the use of variables manipulated with the cfg
command. There are also diagnostic commands.

The cfg command include the following

cfg -s List variables.

cfg -a var=value Add or change a variable value.

cfg -c Commit the change to flash.

cfg -x Reset settings to factory defaults.

cfg -r var Remove variable.
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cfg -e Export variables.

cfg -h Display help for all commands.

The configuration variables are:

Var Description and Values

AC_CTL_PORT WiFi Controller control (CAPWAP) port. Default 5246.

AC_DATA_CHAN_SEC

Data channel security.

0 - Clear text

1 - DTLS (encrypted)

2 - Accept either DTLS or clear text (default)

AC_DISCOVERY_TYPE 1 - Static. Specify WiFi Controllers

2 - DHCP

3 - DNS

5 - Broadcast

6 - Multicast

0 - Cycle through all of the discovery types until successful.

AP_IPADDR
AP_NETMASK
IPGW

These variables set the FortiAP unit IP address, netmask
and default gateway when ADDR_MODE is STATIC.

Default 192.168.1.2 255.255.255.0, gateway
192.168.1.1.

AC_HOSTNAME_1
AC_HOSTNAME_2
AC_HOSTNAME_3

WiFi Controller host names for static discovery.

AC_IPADDR_1
AC_IPADDR_2
AC_IPADDR_3

WiFi Controller IP addresses for static discovery.

AC_DISCOVERY_DHCP_OPTION_CODE Option code for DHCP server. Default 138.

AC_DISCOVERY_MC_ADDR Multicast address for controller discovery. Default
224.0.1.140.
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Var Description and Values

ADDR_MODE How the FortiAP unit obtains its IP address and netmask.

DHCP - FortiGate interface assigns address.

STATIC - Specify in AP_IPADDR and AP_NETMASK.

Default is DHCP.

ADMIN_TIMEOUT Administrative timeout in minutes. Applies to Telnet and
web-based manager sessions. Default is 5 minutes.

AP_MGMT_VLAN_ID Non-zero value applies VLAN ID for unit management.
Default: 0.

AP_MODE

FortiAP operating mode.

0 - Thin AP (default)

2 - Unmanaged Site Survey mode. See SURVEY
variables.

BAUD_RATE Console data rate: 9600, 19200, 38400, 57600, or 115200
baud.

DNS_SERVER DNSServer for clients. If ADDR_MODE is DHCP the DNS
server is automatically assigned.

FIRMWARE_UPGRADE Default is 0.

HTTP_ALLOW Access to FortiAP web-based manager
1 - Yes (default), 0 - No.

LED_STATE Enable/disable status LEDs.
0 - LEDs enabled, 1 - LEDs disabled, 2 - follow AC setting.

LOGIN_PASSWD Administrator login password. By default this is empty.

STP_MODE Spanning Tree Protocol. 0 is off. 1 is on.

TELNET_ALLOW
By default (value 0), Telnet access is closed when the
FortiAP unit is authorized. Set value to 1 to keep Telnet
always available.

WTP_LOCATION Optional string describing AP location.

Mesh variables
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Var Description and Values

MESH_AP_BGSCAN Enable or disable background mesh root AP scan.

0 - Disabled

1 - Enabled

MESH_AP_BGSCAN_RSSI

If the root AP's signal is weak, and lower than the
received signal strength indicator (RSSI) threshold, the
WiFi driver will immediately start a new round scan and
ignore the configured MESH_AP_BGSCAN_PERIOD
delays. Set the value between 0-127.

After the new round scan is finished, a scan done event is
passed to wtp daemon to trigger roaming.

MESH_AP_BGSCAN_PERIOD Time in seconds that a delay period occurs between
scans. Set the value between 1-3600.

MESH_AP_BGSCAN_IDLE Time in milliseconds. Set the value between 0-1000.

MESH_AP_BGSCAN_INTV Time in milliseconds between channel scans. Set the
value between 200-16000.

MESH_AP_BGSCAN_DUR Time in milliseconds that the radio will continue scanning
the channel. Set the value between 10-200.

MESH_AP_SCANCHANLIST Specify those channels to be scanned.

MESH_AP_TYPE

Type of communication for backhaul to controller:

0 - Ethernet (default)

1 - WiFi mesh

2 - Ethernet with mesh backup support

MESH_AP_SSID SSID for mesh backhaul. Default: fortinet.mesh.root

MESH_AP_BSSID WiFi MAC address

MESH_AP_PASSWD Pre-shared key for mesh backhaul.

MESH_ETH_BRIDGE

1 - Bridge mesh WiFi SSID to FortiAP Ethernet port. This
can be used for point-to-point bridge configuration. This is
available only when MESH_AP_TYPE =1.

0 - No WiFi-Ethernet bridge (default).
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Var Description and Values

MESH_MAX_HOPS Maximum number of times packets can be passed from
node to node on the mesh. Default is 4.

The following factors are summed and the FortiAP associates with the lowest scoring mesh AP.

MESH_SCORE_HOP_WEIGHT  Multiplier for number of mesh hops from root. Default 50.

MESH_SCORE_CHAN_WEIGHT  AP total RSSI multiplier. Default 1.

MESH_SCORE_RATE_WEIGHT  Beacon data rate multiplier. Default 1.

MESH_SCORE_BAND_WEIGHT  Band weight (0 for 2.4GHz, 1 for 5GHz) multiplier. Default
100.

MESH_SCORE_RSSI_WEIGHT  AP channel RSSI multiplier. Default 100.

Survey variables

SURVEY_SSID SSID to broadcast in site survey mode (AP_MODE=2).

SURVEY_TX_POWER Transmitter power in site survey mode (AP_MODE=2).

SURVEY_CH_24 Site survey transmit channel for the 2.4Ghz band (default
6).

SURVEY_CH_50 Site survey transmit channel for the 5Ghz band (default
36).

SURVEY_BEACON_INTV Site survey beacon interval. Default 100msec.

Previously, FortiAP accepted Telnet and HTTP connection to any virtual interfaces
that have an IP address. For security reasons, Telnet and HTTP access are now
limited to br0 or br.vlan for AP_MGMT_VLAN_ID.

Diagnose commands include:

cw_diag help Display help for all diagnose commands.

cw_diag uptime Show daemon uptime.

cw_diag --tlog <on|off> Turn on/off telnet log message.

cw_diag --clog <on|off> Turn on/off console log message.

cw_diag baudrate [9600 | 19200 |
38400 | 57600 | 115200]

Set the console baud rate.
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cw_diag plain-ctl [0|1] Show or change current plain control setting.

cw_diag sniff-cfg ip port Set sniff server ip and port.

cw_diag sniff [0|1|2] Enable/disable sniff packet.

cw_diag stats wl_intf Show wl_intf status.

cw_diag admin-timeout [30] Set shell idle timeout in minutes.

cw_diag -c wtp-cfg Show current wtp config parameters in control plane.

cw_diag -c radio-cfg Show current radio config parameters in control plane.

cw_diag -c vap-cfg Show current vaps in control plane.

cw_diag -c ap-rogue Show rogue APs pushed by AC for on-wire scan.

cw_diag -c sta-rogue Show rogue STAs pushed by AC for on-wire scan.

cw_diag -c arp-req Show scanned arp requests.

cw_diag -c ap-scan Show scanned APs.

cw_diag -c sta-scan Show scanned STAs.

cw_diag -c sta-cap Show scanned STA capabilities.

cw_diag -c wids Show scanned WIDS detections.

cw_diag -c darrp Show darrp radio channel.

cw_diag -c mesh Show mesh status.

cw_diag -c mesh-veth-acinfo Show mesh veth ac info, and mesh ether type.

cw_diag -c mesh-veth-vap Show mesh veth vap.

cw_diag -c mesh-veth-host Show mesh veth host.

cw_diag -c mesh-ap Show mesh ap candidates.

cw_diag -c scan-clr-all Flush all scanned AP/STA/ARPs.

cw_diag -c ap-suppress Show suppressed APs.

cw_diag -c sta-deauth De-authenticate an STA.
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Link aggregation can also be set in the CLI. Link aggregation is used to combine
multiple network connections in parallel in order to increase throughput beyond what
a single connection could sustain.

l FortiAP 320B and 320C models are supported.
l FortiAP 112B and 112D models cannot support link aggregation.
l NPI FAP-S3xxCR and "wave2" FAP/FAP-Smodels will have link aggregation feature
via synchronization with regular FortiAP trunk build.
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Chapter 13 - Hardening

Hardening

This guide describes some of the techniques used to harden (improve the security of) FortiGate devices and
FortiOS.

This document contains the following sections:

l Building security into FortiOS
l FortiOS ports and protocols
l Security best practices

Building security into FortiOS

The FortiOS operating system, FortiGate hardware devices, and FortiOS virtual machines (VMs) are built with
security in mind, so many security features are built into the hardware and software. Fortinet maintains an
ISO:9001 certified software and hardware development processes to ensure that FortiOS and FortiGate products
are developed in a secure manner

Boot PROM and BIOS security
The boot PROM and BIOS in FortiGate hardware devices use Fortinet's own FortiBootLoader that is designed
and controlled by Fortinet. FortiBootLoader is a secure, proprietary BIOS for all FortiGate appliances. FortiGate
physical devices always boot from FortiBootLoader.

FortiOS kernel and user processes
FortiOS is a multi-process operating system with kernel and user processes. The FortiOS kernel runs in a
privileged hardware mode while higher-level applications run in user mode. FortiOS is a closed system that does
not allow the loading or execution of third-party code in the FortiOS user space. All non-essential services,
packages, and applications are removed.

FortiGate appliances with SD drives are encrypted to prevent unauthorized access to data.

Administration access security
This section describes FortiOS and FortiGate administration access security features.

Admin administrator account

All FortiGate firewalls ship with a default administrator account called admin. By default, this account does not
have a password. FortiOS allows administrators to add a password for this account or to remove the account and
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create new custom super_admin administrator accounts.

For more information, see Rename the admin administrator account on page 1578.

Secure password storage

User and administrator passwords are stored securely on the system in an encrypted format. The encryption hash
used for admin account passwords is SHA256/SHA1. The value that is seen in the configuration file is the Base64
encoded hash value. For example:

config system admin
edit "admin"

set accprofile "super_admin"
set vdom "root"
set password ENC SH2nlSm9QL9tapcHPXIqAXvX7vBJuuqu22hpa0JX0sBuKIo7z2g0Kz/+0KyH4E=

next
end

Pre-shared keys in IPSec phase-1 configurations are stored in plain text. In the configuration file these pre-shared
keys are encoded. The encoding consists of encrypting the password with a fixed key using DES (AES in FIPS
mode) and then Base64 encoding the result.

Maintainer account

Administrators with physical access to a FortiGate appliance can use a console cable and a special administrator
account called maintainer to log into the CLI. When enabled, the maintainer account can be used to log in from
the console after a hard reboot. The password for the maintainer account is bcpb followed by the FortiGate serial
number. An administrator has 60-seconds to complete this login. See Resetting a lost Admin password on the
Fortinet Cookbook for details.

The only action the maintainer account has permissions to perform is to reset the passwords of super_admin
accounts. Logging in with the maintainer account requires rebooting the FortiGate. FortiOS generates event log
messages when you login with the maintainer account and for each password reset.

The maintainer account is enabled by default; however, there is an option to disable this feature. The maintainer
account can be disabled using the following command:

config system global
set admin-maintainer disable

end

If you disable this feature and lose your administrator passwords you will no longer be
able to log into your FortiGate.

Administrative access security

Secure administrative access features:

l SSH, Telnet, and SNMP are disabled by default. If required, these admin services must be explicitly enabled on
each interface from the GUI or CLI.

l SSHv1 is disabled by default. SSHv2 is the default version.
l SSLv3 and TLS1.0 are disabled by default. TLSv1.1 and TLSv1.2 are the SSL versions enabled by default for

HTTPS admin access.
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l HTTP is disabled by default, except on dedicated MGMT, DMZ, and predefined LAN interfaces. HTTP redirect to
HTTPS is enabled by default.

l The strong-crypto global setting is enabled by default and configures FortiOS to use strong ciphers (AES,
3DES) and digest (SHA1) for HTTPS/SSH/TLS/SSL functions.

l SCP is disabled by default. Enabling SCP allows downloading the configuration file from the FortiGate as an
alternative method of backing up the configuration file. To enable SCP:

config system global
set admin-scp enable

end

l DHCP is enabled by default on the dedicated MGMT interface and on the predefined LAN port (defined on some
FortiGate models).

l On FortiGate models with dedicated MGMT interfaces, dedicated DMZ interfaces, dedicated WAN interfaces, and
pre-defined LAN interfaces, the default management access on interfaces is shown below. Outside of the
interfaces listed below, management access must be explicitly enabled on interfaces – management services are
enabled on specific interfaces and not globally.

l Dedicated Management Interface
l Ping
l FMG-Access (fgfm)
l CAPWAP
l HTTPS
l HTTP

l Dedicated WAN1/WAN2 Ports
l Ping
l FMG-Access (fgfm)

l Dedicated DMZ Port
l Ping
l FMG-Access (fgfm)
l CAPWAP
l HTTPS
l HTTP

l Pre-Defined LAN Port
l Ping
l FMG-Access (fgfm)
l CAPWAP
l HTTPS
l HTTP

Network security
This section describes FortiOS and FortiGate network security features.

Network interfaces

The following are disabled by default on each FortiGate interface:

l Broadcast forwarding
l STP forwarding
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l VLAN forwarding
l L2 forwarding
l Netbios forwarding
l Ident accept

For more information, see Disable unused protocols on interfaces on page 1581.

TCP sequence checking

FortiOS uses TCP sequence checking to ensure a packet is part of a TCP session. By default, anti-replay
protection is strict, which means that if a packet is received with sequence numbers that fall out of the expected
range, FortiOS drops the packet. Strict anti-replay checking performs packet sequence checking and ICMP anti-
replay checking with the following criteria:

l The SYN, FIN, and RST bit cannot appear in the same packet.
l FortiOS does not allow more than 1 ICMP error packet to go through before it receives a normal TCP or UDP

packet.
l If FortiOS receives an RST packet, FortiOS checks to determine if its sequence number in the RST is within the un-

ACKed data and drops the packet if the sequence number is incorrect.
l For each new session, FortiOS checks to determine if the TCP sequence number in a SYN packet has been

calculated correctly and started from the correct value.

Reverse path forwarding

FortiOS implements a mechanism called Reverse Path Forwarding (RPF), or Anti Spoofing, to block an IP packet
from being forwarded if its source IP does not:

l belong to a locally attached subnet (local interface), or
l be in the routing domain of the FortiGate from another source (static route, RIP, OSPF, BGP).

If those conditions are not met, FortiOS silently drops the packet.

FIPS and Common Criteria
FortiOS has received NDPP, EAL2+, and EAL4+ based FIPS and Common Criteria certifications. Common
Criteria evaluations involve formal rigorous analysis and testing to examine security aspects of a product or
system. Extensive testing activities involve a comprehensive and formally repeatable process, confirming that the
security product functions as claimed by the manufacturer. Security weaknesses and potential vulnerabilities are
specifically examined during an evaluation.

To see Fortinet's complete history of FIPS/CC certifications go to the following URL and add Fortinet to the
Vendor field:

https://csrc.nist.gov/projects/cryptographic-module-validation-program/validated-modules/search

PSIRT advisories
The FortiGuard Labs Product Security Incident Response Team (PSIRT) continually tests and gathers
information about Fortinet hardware and software products, looking for vulnerabilities and weaknesses. Any such
findings are fed back to Fortinet's development teams and serious issues are described along with protective
solutions. The PSIRT regulatory releases PSIRT advisories when issues are found and corrected. Advisories are
listed at https://www.fortiguard.com/psirt.
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FortiOS ports and protocols

Communication to and from FortiOS is strictly controlled and only selected ports are opened for supported
functionality such as administrator logins and communication with other Fortinet products or services.

Accessing FortiOS using an open port is protected by authentication, identification, and encryption requirements.
As well, ports are only open if the feature using them is enabled.

FortiOS open ports
The following diagram and tables shows the incoming and outgoing ports that are potentially opened by FortiOS.
For more details about open ports and the communication protocols that FortiOS uses, see the document
Fortinet Communication Ports and Protocols.
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Incoming ports

Purpose Protocol/Port

FortiAP-S Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/443

CAPWAP UDP/5246, UDP/5247

FortiAuthenticator RADIUS UDP/1812

FSSO TCP/8000

FortiGate HAHeartbeat ETH Layer 0x8890, 0x8891, and 0x8893

HA Synchronization TCP/703, UDP/703

FortiGuard Management TCP/541

AV/IPS UDP/9443

FortiManager AV/IPS Push UDP/9443

SSH CLI Management TCP/22

Management TCP/541

SNMP Poll UDP/161, UDP/162

FortiGuard Queries TCP/443

FortiPortal API communications (FortiOS REST API,
used for Wireless Analytics)

TCP/443

Others Web Admin TCP/80, TCP/443

FSSO TCP/8000

Policy Override Authentication TCP/443, TCP/8008, TCP/8010

FortiClient Portal TCP/8009

Policy Override Keepalive TCP/1000, TCP/1003

SSL VPN TCP/10443

3rd-Party Servers FSSO TCP/8000
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Outgoing ports

Purpose Protocol/Port

FortiAnalyzer Syslog, OFTP, Registration, Quarantine,
Log & Report

TCP/514

FortiAuthenticator LDAP, PKI Authentication TCP or UDP/389

FortiCloud Registration, Quarantine, Log & Report,
Syslog

TCP/443

OFTP TCP/514

Management TCP/541

Contract Validation TCP/443

FortiGate HAHeartbeat ETH Layer 0x8890, 0x8891, and 0x8893

HA Synchronization TCP/703, UDP/703

FortiGuard AV/IPS Update TCP/443, TCP/8890

Cloud App DB TCP/9582

FortiGuard Queries UDP/53, UDP/8888

DNS UDP/53, UDP/8888

Registration TCP/80

Alert Email, Virus Sample TCP/25

Management, Firmware, SMS, FTM,
Licensing, Policy Override

TCP/443

Central Management, Analysis TCP/541

FortiManager Management TCP/541

IPv6 FGFM connection TCP/542

Log & Report TCP or UDP/514

Secure SNMP UDP/161, UDP/162

FortiGuard Queries TCP/8890, UDP/53

FortiSandbox OFTP TCP/514
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Note that, while a proxy is configured, FortiGate uses the following URLs to access
the FortiGuard Distribution Network (FDN):

l update.fortiguard.net
l service.fortiguard.net
l support.fortinet.com

Closing open ports
You can close open ports by disabling the feature that opens them. For example, if FortiOS is not managing a
FortiAP then the CAPWAP feature for managing FortiAPs can be disabled, closing the CAPWAP port.

The following sections of this documnent described a number of options for closing open ports:

l Use local-in policies to close open ports or restrict access on page 1582
l Disable unused protocols on interfaces on page 1581

Security best practices

This chapter describes some techniques and best practices that you can use to improve FortiOS security.

Install the FortiGate unit in a physically secure location
A good place to start with is physical security. Install your FortiGate in a secure location, such as a locked room or
one with restricted access. A restricted location prevents unauthorized users from getting physical access to the
device.

If unauthorized users have physical access, they can disrupt your entire network by disconnecting your FortiGate
(either by accident or on purpose). They could also connect a console cable and attempt to log into the CLI. Also,
when a FortiGate unit reboots, a person with physical access can interrupt the boot process and install different
firmware.

Register your product with Fortinet Support
You need to register your Fortinet product with Fortinet Support to receive customer services, such as firmware
updates and customer support. You must also register your product for FortiGuard services, such as up-to-date
antivirus and IPS signatures. Register your product by visiting https://support.fortinet.com.

Keep your FortiOS firmware up to date
Always keep FortiOS up to date. The most recent version is the most stable and has the most bugs fixed and
vulnerabilities removed.
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Fortinet periodically updates the FortiGate firmware to include new features and resolve important issues. After
you register your FortiGate or FortiOS VM, download firmware updates from the support web site,
https://support.fortinet.com.

Before you install any new firmware, be sure to follow these steps:

l Review the Release Notes for the latest firmware release.
l Review the Supported Upgrade Paths guide to determine the best path to take from your current version of FortiOS

to the latest version.
l Back up the current configuration.

Only FortiGate administrators who have read and write privileges can upgrade the FortiOS firmware.

System administrator best practices
This section describes a collection of changes you can implement to make administrative access to the GUI and
CLI more secure.

Disable administrative access to the external (Internet-facing) interface

When possible, don’t allow administration access on the external (Internet-facing) interface.

To disable administrative access, go to Network > Interfaces, edit the external interface and disable HTTPS,
PING, HTTP, SSH, and TELNET underAdministrative Access.

From the CLI:

config system interface
edit <external-interface-name>
unset allowaccess

end

Allow only HTTPS access to the GUI and SSH access to the CLI

For greater security never allow HTTP or Telnet administrative access to a FortiGate interface, only allow HTTPS
and SSH access. You can change these settings for individual interfaces by going to Network > Interfaces and
adjusting the administrative access to each interface.

From the CLI:

config system interface
edit <interface-name>

set allowaccess https ssh
end

Require TLS 1.2 for HTTPS administrator access

Use the following command to require TLS 1.2 for HTTPS administrator access to the GUI:

config system global
set admin-https-ssl-versions tlsv1-2

end

TLS 1.2 is currently the most secure SSL/TLS supported version for SSL-encrypted administrator access.
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Re-direct HTTP GUI logins to HTTPS

Go to System > Settings > Administrator Settings and enable Redirect to HTTPS to make sure that all
attempted HTTP login connections are redirected to HTTPS.

From the CLI:

config system global
set admin-https-redirect enable

end

Change the HTTPS and SSH admin access ports to non-standard ports

Go to System > Settings > Administrator Settings and change the HTTPS and SSH ports.

You can change the default port configurations for HTTPS and SSH administrative access for added security. To
connect to a non-standar port, the new port number must be included in the collection request. For example:

l If you change the HTTPS port to 7734, you would browse to https://<ip-address>:7734.
l If you change the SSH port to 2345, you would connect to ssh admin@<ip-address>:2345

To change the HTTPS and SSH login ports from the CLI:

config system global
set admin-sport 7734
set admin-ssh-port 2345

end

If you change to the HTTPS or SSH port numbers, make sure your changes do not conflict with ports used for
other services.

Maintain short login timeouts

Set the idle timeout to a short time to avoid the possibility of an administrator walking away from their
management computer and leaving it exposed to unauthorized personnel.

To set the administrator idle timeout, go to System > Settings and enter the amount of time for the Idle
timeout. A best practice is to keep the default time of 5 minutes.

To set the administrator idle timeout from the CLI:

config system global
set admintimeout 5

end

You can use the following command to adjust the grace time permitted between making an SSH connection and
authenticating. The range can be between 10 and 3600 seconds, the default is 120 seconds (minutes). By
shortening this time, you can decrease the chances of someone attempting a brute force attack a from being
successfull. For example, you could set the time to 30 seconds.

config system global
set admin-ssh-grace-time 30

end

Restrict logins from trusted hosts

Setting up trusted hosts for an administrator limits the addresses from where they can log into FortiOS. The
trusted hosts configuration applies to all forms of administrative access including HTTPS, SSH, ping, and SNMP.
When you identify a trusted host for an administrator account, FortiOS accepts that administrator’s login only
from one of the trusted hosts. A login, even with proper credentials, from a non-trusted host is dropped.
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To identify trusted hosts, go to System > Administrators, edit the administrator account, enable Restrict
login to trusted hosts, and add up to ten trusted host IP addresses.

To add two trusted hosts from the CLI:

config system admin
edit <administrator-name>

set trustedhost1 172.25.176.23 255.255.255.255
set trustedhost2 172.25.177.0 255.255.255.0

end

Trusted host IP addresses can identify individual hosts or subnets. Just like firewall policies, FortiOS searches
through the list of trusted hosts in order and acts on the first match it finds. When you configure trusted hosts,
start by adding specific addresses at the top of the list. Follow with more general IP addresses. You don't have to
add addresses to all of the trusted hosts as long as all specific addresses are above all of the 0.0.0.0 0.0.0.0
addresses.

Set up two-factor authentication for administrators

FortiOS supports FortiToken and FortiToken Mobile 2-factor authentication. FortiToken Mobile is available for
iOS and Android devices from their respective application stores.

Every registered FortiGate unit includes two trial tokens for free. You can purchase additional tokens from your
reseller or from Fortinet.

To assign a token to an administrator, go to System > Administrators and select Enable Two-factor
Authentication for each administrator.

Create multiple administrator accounts

Rather than allowing all administrators to access ForiOS with the same administrator account, you can create
accounts for each person or each role that requires administrative access. This configuraion allows you to track
the activities of each administrator or administrative role.

If you want administrators to have different functions you can add different administrator profiles. Go to System
> Admin Profiles and select Create New.

Modify administrator account lockout duration and threshold values

By default, the FortiGate sets the number of password retries at three, allowing the administrator a maximum of
three attempts to log into their account before locking the account for a set amount of time.

Both the number of attempts (admin-lockout-threshold) and the wait time before the administrator can
try to enter a password again (admin-lockout-duration) can be configured within the CLI.

To configure the lockout options:

config system global
set admin-lockout-threshold <failed_attempts>
set admin-lockout-duration <seconds>

end

The default value of admin-lockout-threshold is 3 and the range of values is between 1 and 10. The
admin-lockout-duration is set to 60 seconds by default and the range of values is between 1 and
4294967295 seconds.
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Keep in mind that the higher the lockout threshold, the higher the risk that someone may be able to break into the
FortiGate unit.

Example:

To set the admin-lockout-threshold to one attempt and the admin-lockout-duration to a five
minute duration before the administrator can try to log in again, enter the commands:

config system global
set admin-lockout-threshold 1
set admin-lockout-duration 300

end

If the time span between the first failed login attempt and the admin-lockout-
threshold failed login attempt is less than admin-lockout-duration, the
lockout will be triggered.

Rename the admin administrator account

You can improve security by renaming the admin account. To do this, create a new administrator account with the
super_admin admin profile and log in as that administrator. Then go to System > Administrators and edit the
admin administrator and change the User Name. Renaming the admin account makes it more difficult for an
attacker to log into FortiOS.

Add administrator disclaimers

FortiOS can display a disclaimer before or after logging into the GUI or CLI (or both). In either case the
administrator must read and accept the disclaimer before they can proceed.

Use the following command to display a disclaimer before logging in:

config system global
set pre-login-banner enable

end

Use the following command to display a disclaimer after logging in:

config system global
set post-login-banner enable

end

You can customize the replacement messages for these disclaimers by going to System > Replacement
Messages. Select Extended View to view and edit the Administrator replacement messages.

From the CLI:

config system replacemsg admin pre_admin-disclaimer-text
config system replacemsg admin post_admin-disclaimer-text

Global commands for stronger and more secure encryption
This section describes some best practices for employing stronger and more secure encryption.
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Turn on global strong encryption

Enter the following command to configure FortiOS to use only strong encryption and allow only strong ciphers
(AES, 3DES) and digest (SHA1) for HTTPS, SSH, TLS, and SSL functions.

config sys global
set strong-crypto enable

end

Disable MD5 and CBC for SSH

In some cases, you may not be able to enable strong encryption. For example, your FortiGate may be
communicating with a system that does not support strong encryption. With strong-crypto disabled you can
use the following options to prevent SSH sessions with the FortiGate from using less secure MD5 and CBC
algorithms:

config sys global
set ssh-hmac-md5 disable
set ssh-cbc-cipher disable

end

Disable static keys for TLS

You can use the following command to prevent TLS sessions from using static keys (AES128-SHA, AES256-SHA,
AES128-SHA256, AES256-SHA256):

config sys global
set ssl-static-key-ciphers disable

end

Require larger values for Diffie-Hellman exchanges

Larger Diffie-Helman values result in stronger encryption. Use the following command to force Diffie-Hellman
exchanges to use 8192 bit values (the highest configurable DH value).

config sys global
set dh-params 8192

end

Disable sending Malware statistics to FortiGuard
By default FortiOS periodically sends encrypted Malware statistics to FortiGuard. The Malware statistics record
Antivirus, IPS, or Application Control events. This data is used to improved FortiGuard services. The Malware
statistics that are sent do not include any personal or sensitive customer data. The information is not shared with
any external parties and is used in accordance with Fortinet's Privacy Policy.

To disable sending Malware statistics to FortiGuard, enter the following command:

config system global
set fds-statistics disable

end

Disable auto USB installation
If USB installation is enabled, an attacker with physical access to a FortiGate could load a new configuration or
firmware on the FortiGate using the USB port. You can disable USB installation by entering the following from the
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CLI:

config system auto-install
set auto-install-config disable
set auto-install-image disable

end

Set system time by synchronizing with an NTP server
For accurate time, use an NTP server to set system time. Synchronized time facilitates auditing and consistency
between expiry dates used in expiration of certificates and security protocols.

From the GUI go to System > Settings > System Time and select Synchronize with NTP Server. By
default, this causes FortiOS to synchronize with Fortinet's FortiGuard secure NTP server.

From the CLI you can use one or more different NTP servers:

config system ntp
set type custom
set ntpsync enable

config ntpserver
edit 1

set server <ntp-server-ip>
next
edit 2

set server <other-ntp-server-ip>
end

Enable password policies
Go to System > Settings > Password Policy, to create a password policy that all administrators must follow.
Using the available options you can define the required length of the password, what it must contain (numbers,
upper and lower case, and so on) and an expiry time.

Use the password policy feature to make sure all administrators use secure passwords that meet your
organization's requirements.

Configure auditing and logging
For optimum security go to Log & Report > Log Settings enable Event Logging. For best results send log
messages to FortiAnalyzer or FortiCloud.

From FortiAnalyzer or FortiCloud, you can view reports or system event log messages to look for system events
that may indicate potential problems. You can also view system events by going to FortiView > System
Events.

Establish an auditing schedule to routinely inspect logs for signs of intrusion and probing.

Encrypt logs sent to FortiAnalyzer/FortiManager

To keep information in log messages sent to FortiAnalyzer private, go to Log & Report > Log Settings and
when you configure Remote Logging to FortiAnalyzer/FortiManager select Encrypt log transmission.

From the CLI.

config log {fortianalyzer | fortianalyzer2 | fortianalyzer3} setting
set enc-algorithm high
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end

Disable interfaces that not used
To disable an interface from the GUI, go to Network > Interfaces. Edit the interface to be disabled and set
Interface State to Disabled.

From the CLI, to disable the port21 interface:

config system interface
edit port21

set status down
end

Disable unused protocols on interfaces
You can use the config system interface command to disable unused protocols that attackers may
attempt to use to gather information about a FortiGate unit. Many of these protocols are disabled by default.
Using the config system interface command you can see the current configuration of each of these
options for the selected interface and then choose to disable them if required.

config system interface
edit <interface-name>

set dhcp-relay-service disable
set pptp-client disable
set arpforward disable
set broadcast-forward disable
set l2forward disable
set icmp-redirect disable
set vlanforward disable
set stpforward disable
set ident-accept disable
set ipmac disable
set netbios-forward disable
set security-mode none
set device-identification disable
set lldp-transmission disable

end

Option Description

dhcp-relay-service Disable the DHCP relay service.

pptp-client Disable operating the interface as a PPTP client.

arpforward Disable ARP forwarding.

broadcast-forward Disable forwarding broadcast packets.

l2forward Disable layer 2 forwarding.

icmp-redirect Disable ICMP redirect.
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Option Description

vlanforward Disable VLAN forwarding.

stpforward Disable STP forwarding.

ident-accept Disable authentication for this interface. The interface will not respond to a
connection with an authentication prompt.

ipmac Disable IP/MAC binding.

netbios-forward Disable NETBIOS forwarding.

security-mode Set to none to disable captive portal authentication. The interface will not
respond to a connection with a captive portal.

device-identification Disable device identification.

lldp-transmission Disable link layer discovery (LLDP).

Use local-in policies to close open ports or restrict access
You can also use local-in policies to close open ports or otherwise restrict access to FortiOS.

Close ICMP ports

Use the following command to close all ICMP ports on the WAN1 interface. The following example blocks traffic
that matches the ALL_ICMP firewall service.

config firewall local-in-policy
edit 1

set intf wan1
set scraddr all
set dstaddr all
set action deny
set service ALL_ICMP
set schedule always

end

Close the BGP port

Use the following command to close the BGP port on the wan1 interface. The following example blocks traffic
that matches the BGP firewall service.

config firewall local-in-policy
edit 1

set intf wan1
set scraddr all
set dstaddr all
set action deny
set service BGP
set schedule always
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end
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Chapter 14 - Hardware Acceleration

Hardware acceleration

This document describes the Security Processing Unit (SPU) hardware that Fortinet builds into FortiGate devices
to accelerate traffic through FortiGate units. Three types of SPUs are described:

l Content processors (CPs) that accelerate a wide range of security functions
l Security processors (SPs) that accelerate specific security functions
l Network processors (NPs and NPLites) that offload network traffic to specialized hardware that is optimized to

provide high levels of network throughput.

This FortiOS Handbook chapter contains the following sections:

Hardware acceleration overview describes the capabilities of FortiGate content processors (CPs), security
processors (SPs) and network processors (NPs). This chapter also describes how to determine the hardware
acceleration components installed in your FortiGate unit and contains some configuration details and examples.

NP6 and NP6lite Acceleration describes the FortiGate NP6 network processor.

FortiGate NP6 architectures contains details about the network processing architectures of FortiGate units that
contain NP6 processors.

FortiGate NP6lite architectures on page 1682 contains details about the network processing architectures of
FortiGate units that contain NP6Lite processors.

NP4 and NP4Lite Acceleration describes the FortiGate NP4 network processor.

FortiGate NP4 architectures contains details about the network processing architectures of FortiGate units that
contain NP4 processors.

Whats New in Hardware Acceleration for FortiOS 5.6
The following new hardware acceleration feature has been added to FortiOS 5.6.4.

l Per-session accounting is supported for FortiGates with NP6lite processors, Enabling per-session accounting for
offloaded NP6 or NP6lite sessions on page 1620.

Bandwidth control between the ISF and NP6 XAUI ports (437911)

In some cases, the Internal Switch Fabric (ISF) buffer size may be larger than the buffer size of an NP6 XAUI port
that receives traffic from the ISF. If this happens, burst traffic from the ISF may exceed the capacity of an XAUI
port and sessions may be dropped.

You can use the following command to configure bandwidth control between the ISF and XAUI ports. Enabling
bandwidth control can smooth burst traffic and keep the XAUI ports from getting overwhelmed and dropping
sessions.

Use the following command to enable bandwidth control:

config system npu
set sw-np-bandwidth {0G | 2G | 4G | 5G | 6G}

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1584



Hardware acceleration Chapter 14 - Hardware Acceleration

end

The default setting is 0G which means no bandwidth control. The other options limit the bandwidth to 2Gbps,
4Gbps and so on.

SNMP/CLI monitoring capabilities of NP6 session table and session drift (441532)

In some cases sessions processed by NP6 processors may fail to be deleted leading to a large number of idle
sessions. This is called session drift. New monitoring capabilities have been added to allow you to use SNMP to
be alerted when the number of idle sessions becomes high. The SNMP fields allow you to see which NP6
processor has the abnormal number of idle sessions and you can use a diagnose command to delete them.

You can use the following diagnose command to determine of drift is occurring:

diagnose npu np6 sse-drift-summary
NPU drv-drift
----- ---------
np6_0 0
np6_1 0
----- ---------
Sum 0
----- ---------

The command output shows a drift summary for all the NP6 processors in the system, and shows the total drift.
Normally the sum is 0. The previous command output, from a FortiGate-1500D, shows that the 1500D's two NP6
processors are not experiencing any drift.

If the sum is not zero, then extra idle sessions may be accumulating. You can use the following command to
delete those sessions:

diagnose npu np6 sse-purge-drift <np6_id> [<time>]

Where <np6_id> is the number (starting with NP6_0 with a np6_id of 0) of the NP6 processor for which to delete
idle sessions. <time> is the age in seconds of the idle sessions to be deleted. All idle sessions this age and older
are deleted. The default time is 300 seconds.

The diagnose npu np6 sse-stats <np6_id> command output also includes a drv-drift field that
shows the total drift for one NP6 processor.

For SNMPmonitoring, the following MIB fields have been added. These fields allow you to use SNMP to monitor
more session table information for NP6 processors including drift for each NP6 processor.

FORTINET-FORTIGATE-MIB::fgNPUNumber.0 = INTEGER: 2
FORTINET-FORTIGATE-MIB::fgNPUName.0 = STRING: NP6
FORTINET-FORTIGATE-MIB::fgNPUDrvDriftSum.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUIndex.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUIndex.1 = INTEGER: 1
FORTINET-FORTIGATE-MIB::fgNPUSessionTblSize.0 = Gauge32: 33554432
FORTINET-FORTIGATE-MIB::fgNPUSessionTblSize.1 = Gauge32: 33554432
FORTINET-FORTIGATE-MIB::fgNPUSessionCount.0 = Gauge32: 0
FORTINET-FORTIGATE-MIB::fgNPUSessionCount.1 = Gauge32: 0
FORTINET-FORTIGATE-MIB::fgNPUDrvDrift.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUDrvDrift.1 = INTEGER: 0

NP6 Host Protection Engine (HPE) adds protection for DDoS attacks (363398)

NP6 processors now include HPE functionality that can protect networks from DoS attacks by categorizing
incoming packets based on packet rate and processing cost and applying packet shaping to packets that can
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cause DoS attacks. You can use the options in the following CLI command to limit the number packets per
second received for various packet types by each NP6 processor. This rate limiting is applied very efficiently
because it is done in hardware by the NP6 processor.

HPE protection is disable by default. You can use the following command to enable HPE protection for the NP6_0
NP6 processor:

config system np6
edit np6_0

config hpe
set enable-shaper enable

end

HPE can be enabled and configured separately for each NP6 processor. When enabled, the default configuration
is designed to provide basic DoS protection. You can use the following command to adjust the HPE settings in
real time if you network is experiencing an attack. For example, the following command allows you to configure
HPE settings for np6_0.

config system np6
edit np6_0

config hpe
set tcpsyn-max
set tcp-max
set udp-max
set icmp-max
set sctp-max
set esp-max
set ip-frag-max
set ip-others-max
set arp-max
set l2-others-max
set enable-shaper {disable | enable}

end

Where:

tcpsyn-max applies shaping based on the maximum number of TCP SYN packets received per second. The
range is 10,000 to 4,000,000,000 pps. The default limits the number of packets per second to 5,000,000 pps.

tcp-max applies shaping based on the maximum number of TCP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 5,000,000 pps.

udp-max applies shaping based on the maximum number of UDP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 5,000,000 pps.

icmp-max applies shaping based on the maximum number of ICMP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 1,000,000 pps.

sctp-max applies shaping based on the maximum number of SCTP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 100,000 pps.

esp-max NPU HPE shaping based on the maximum number of IPsec ESP packets received. The range is
10,000 to 4,000,000,000 pps. The default is 100,000 pps.

ip-frag-max applies shaping based on the maximum number of fragmented IP packets received. The range is
10,000 to 4,000,000,000 pps. The default is 100,000 pps.

ip-others-max applies shaping based on the maximum number of other IP packets received. The range is
10,000 to 4,000,000,000 pps. The default is 100,000 pps.
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arp-max applies shaping based on the maximum number of ARP packets received. The range is 10,000 to
4,000,000,000 pps. The default is 1,000,000 pps.

l2-others-max applies shaping based on the maximum number of other layer 2 packets received. The range
is 10,000 to 4,000,000,000 pps. The default is 100,000 pps.

Improved visibility of SPU and nTurbo hardware acceleration (389711)

All hardware acceleration hardware has been renamed Security Processing Units (SPUs). This includes NPx and
CPx processors.

SPU and nTurbo data is now visible in a number of places on the GUI. For example, the Active Sessions column
pop-up in the firewall policy list and the Sessions dashboard widget.

The following example shows the Sessions dashboard widget tracking SPU and nTurbo sessions. Current
sessions shows the total number of sessions, SPU shows the percentage of these sessions that are SPU
sessions and Nturbo shows the percentage that are nTurbo sessions.

You can also add SPU filters to many FortiView pages.

NP4Lite option to disable offloading ICMP traffic in IPsec tunnels (383939)

In some cases ICMP traffic in IPsec VPN tunnels may be dropped by the NP4Lite processor due to a bug with the
NP4Lite firmware. You can use the following command to avoid this problem by preventing the NP4Lite processor
from offloading ICMP sessions in IPsec VPN tunnels. This command is only available on FortiGate models with
NP4Lite processors, such as the FortiGate/FortiWiFi-60D.

config system npu
set process-icmp-by-host {disable | enable}

end

The option is disabled by default an all ICMP traffic in IPsec VPN tunnels is offloaded where possible. If you are
noticing that ICMP packets in IPsec VPN tunnels are being dropped you can disable this option and have all ICMP
traffic processed by the CPU and not offloaded to the NP4Lite.
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NP6 IPv4 invalid checksum anomaly checking (387675)

The following new options have been added to NP6 processors to check for IPv4 checksum errors in IPv4, TCP,
UDP, and ICMP packets.

config system np6
edit {np6_0 | np6_1| ...}

config fp-anomaly
set ipv4-csum-err {drop | trap-to-host}
set tcp-csum-err {drop | trap-to-host}
set udp-csum-err {drop | trap-to-host}
set icmp-csum-err {drop | trap-to-host}

end

You can use the new options to either drop packets with checksum errors (the default) or send them to the CPU
for processing. Normally you would want to drop these packets.

As well, note that when configuring NP6 anomaly protection, the separate options config fp-anomaly-v4
and config fp-anomaly-v6 have been combined under config fp-anomaly.

Stripping clear text padding and IPsec session ESP padding (416950)

In some situations, when clear text or ESP packets in IPsec sessions may have large amounts of layer 2 padding,
the NP6 IPsec engine may not be able to process them and the session may be blocked.

If you notice dropped IPsec sessions, you could try using the following CLI options to cause the NP6 processor to
strip clear text padding and ESP padding before sending the packets to the IPsec engine. With padding stripped,
the session can be processed normally by the IPsec engine.

Use the following command to strip ESP padding:

config system npu
set strip-esp-padding enable
set strip-clear-text-padding enable

end

Stripping clear text and ESP padding are both disabled by default.

Optionally disable NP6 offloading of traffic passing between 10Gbps and 1Gbps interfaces
(392436)

Due to NP6 internal packet buffer limitations, some offloaded packets received at a 10Gbps interface and
destined for a 1Gbps interface can be dropped, reducing performance for TCP and IP tunnel traffic. If you
experience this performance reduction, you can use the following command to disable offloading sessions
passing from 10Gbps interfaces to 1Gbps interfaces:

config system npu
set host-shortcut-mode host-shortcut

end

Select host-shortcut to stop offloading TCP and IP tunnel packets passing from 10Gbps interfaces to 1Gbps
interfaces. TCP and IP tunnel packets passing from 1Gbps interfaces to 10Gbps interfaces are still offloaded as
normal.

If host-shortcut is set to the default bi-directional setting, packets in both directions are offloaded.
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Hardware acceleration overview

Most FortiGate models have specialized acceleration hardware, (called Security Processing Units (SPUs)) that
can offload resource intensive processing from main processing (CPU) resources. Most FortiGate units include
specialized content processors (CPs) that accelerate a wide range of important security processes such as virus
scanning, attack detection, encryption and decryption. (Only selected entry-level FortiGate models do not include
a CP processor.) Many FortiGate models also contain security processors (SPs) that accelerate processing for
specific security features such as IPS and network processors (NPs) that offload processing of high volume
network traffic.

Content processors (CP4, CP5, CP6, CP8, and CP9)
Most FortiGate models contain FortiASIC Content Processors (CPs) that accelerate many common resource
intensive security related processes. CPs work at the system level with tasks being offloaded to them as
determined by the main CPU. Capabilities of the CPs vary by model. Newer FortiGate units include CP8 and CP9
processors. Older CP versions still in use in currently operating FortiGate models include the CP4, CP5, and CP6.

CP9 capabilities

The CP9 content processor provides the following services:

l Flow-based inspection (IPS, application control etc.) pattern matching acceleration with over 10Gbps throughput
l IPS pre-scan
l IPS signature correlation
l Full match processors

l High performance VPN bulk data engine
l IPsec and SSL/TLS protocol processor
l DES/3DES/AES128/192/256 in accordance with FIPS46-3/FIPS81/FIPS197
l MD5/SHA-1/SHA256/384/512-96/128/192/256 with RFC1321 and FIPS180
l HMAC in accordance with RFC2104/2403/2404 and FIPS198
l ESNmode
l GCM support for NSA "Suite B" (RFC6379/RFC6460) including GCM-128/256; GMAC-128/256

l Key Exchange Processor that supports high performance IKE and RSA computation
l Public key exponentiation engine with hardware CRT support
l Primary checking for RSA key generation
l Handshake accelerator with automatic key material generation
l True Random Number generator
l Elliptic Curve support for NSA "Suite B"
l Sub public key engine (PKCE) to support up to 4096 bit operation directly (4k for DH and 8k for RSAwith CRT)

l DLP fingerprint support
l TTTD (Two-Thresholds-Two-Divisors) content chunking
l Two thresholds and two divisors are configurable
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CP8 capabilities

The CP8 content processor provides the following services:

l Flow-based inspection (IPS, application control etc.) pattern matching acceleration
l High performance VPN bulk data engine

l IPsec and SSL/TLS protocol processor
l DES/3DES/AES in accordance with FIPS46-3/FIPS81/FIPS197
l ARC4 in compliance with RC4
l MD5/SHA-1/SHA256 with RFC1321 and FIPS180
l HMAC in accordance with RFC2104/2403/2404 and FIPS198

l Key Exchange Processor support high performance IKE and RSA computation
l Public key exponentiation engine with hardware CRT support
l Primarily checking for RSA key generation
l Handshake accelerator with automatic key material generation
l Random Number generator compliance with ANSI X9.31
l Sub public key engine (PKCE) to support up to 4096 bit operation directly

l Message authentication module offers high performance cryptographic engine for calculating SHA256/SHA1/MD5
of data up to 4G bytes (used by many applications)

l PCI express Gen 2 four lanes interface
l Cascade Interface for chip expansion

CP6 capabilities

l Dual content processors
l FIPS-compliant DES/3DES/AES encryption and decryption
l SHA-1 and MD5 HMAC with RFC1321 and FIPS180
l HMAC in accordance with RFC2104/2403/2404 and FIPS198
l IPsec protocol processor
l High performance IPsec engine
l Random Number generator compliance with ANSI X9.31
l Key exchange processor for high performance IKE and RSA computation
l Script Processor
l SSL/TLS protocol processor for SSL content scanning and SSL acceleration

CP5 capabilities

l FIPS-compliant DES/3DES/AES encryption and decryption
l SHA-1 and MD5 HMAC with RFC1321/2104/2403/2404 and FIPS180/FIPS198
l IPsec protocol processor
l High performance IPSEC Engine
l Random Number generator compliant with ANSI X9.31
l Public Key Crypto Engine supports high performance IKE and RSA computation
l Script Processor
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CP4 capabilities

l FIPS-compliant DES/3DES/AES encryption and decryption
l SHA-1 and MD5 HMAC
l IPSEC protocol processor
l Random Number generator
l Public Key Crypto Engine
l Content processing engine
l ANSI X9.31 and PKCS#1 certificate support

Determining the content processor in your FortiGate unit

Use the get hardware status CLI command to determine which content processor your FortiGate unit
contains. The output looks like this:

get hardware status
Model name: FortiGate-100D
ASIC version: CP8
ASIC SRAM: 64M
CPU: Intel(R) Atom(TM) CPU D525 @ 1.80GHz
Number of CPUs: 4
RAM: 1977 MB
Compact Flash: 15331 MB /dev/sda
Hard disk: 15272 MB /dev/sda
USB Flash: not available
Network Card chipset: Intel(R) PRO/1000 Network Connection (rev.0000)
Network Card chipset: bcm-sw Ethernet driver 1.0 (rev.)

The ASIC version line lists the content processor model number.

Viewing SSL acceleration status

You can view the status of SSL acceleration using the following command:

get vpn status ssl hw-acceleration-status
Acceleration hardware detected: kxp=on cipher=on

Where kxp means key exchange acceleration.

Disabling CP offloading for firewall policies

If you want to completely disable offloading to CP processors for test purposes or other reasons, you can do so in
security policies. Here are some examples:

For IPv4 security policies.

config firewall policy
edit 1

set auto-asic-offload disable
end

For IPv6 security policies.

config firewall policy6
edit 1

set auto-asic-offload disable
end

For multicast security policies.
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config firewall multicast-policy
edit 1

set auto-asic-offload disable
end

Disabling auto-asic-offload also disables NP offloading.

Security processors (SPs)
FortiGate Security Processing (SP) modules, such as the SP3 but also including the XLP, XG2, XE2, FE8, and
CE4, work at both the interface and system level to increase overall system performance by accelerating
specialized security processing. You can configure the SP to favor IPS over firewall processing in hostile high-
traffic environments.

SP processors include their own IPS engine which is similar to the FortiOS IPS engine but with the following
limitations:

l The SP IPS engine does not support SSL deep inspection. When you have SSL deep inspection enabled for a
security policy that includes flow-based inspection or IPS, offloading to the SP is disabled and traffic is processed by
the FortiGate CPU and CP processors.

l The SP IPS engine does not support FortiGuard Web Filtering. When you enable flow-based FortiGuard Web
Filtering on a FortiGate unit with an SP processor, the SP processor cannot perform FortiGuard lookups and web
pages fail to load.

The following security processors are available:

l The SP3 (XLP) is built into the FortiGate-5101B and provides IPS acceleration. No special configuration is required.
All IPS processing, including traffic accepted by IPv4 and IPv6 traffic policies and IPv4 and IPv6 DoS policies is
accelerated by the built-in SP3 processors.

l The FMC-XG2 is an FMCmodule with two 10Gb/s SPF+ interfaces that can be used on FortiGate-3950B and
FortiGate-3951B units.

l The FortiGate-3140B also contains a built-in XG2 using ports 19 and 20.
l The ADM-XE2 is a dual-width AMCmodule with two 10Gb/s interfaces that can be used on FortiGate-3810A and

FortiGate-5001A-DW systems.
l The ADM-FE8 is a dual-width AMCmodule with eight 1Gb/s interfaces that can be used with the FortiGate-3810A.
l The ASM-CE4 is a single-width AMCmodule with four 10/100/1000 Mb/s interfaces that can be used on FortiGate-

3016B and FortiGate-3810A units.

Traffic is blocked if you enable IPS for traffic passing over inter-VDOM links if that
traffic is being offloaded by an SP processor. If you disable SP offloading, traffic will be
allowed to flow. You can disable offloading in individual firewall policies by disabling
auto-asic-offload for those policies. You can also use the following command
to disable all IPS offloading:

config ips global
set np-accel-mode none
set cp-accel-mode none

end
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SP Processing Flow

SP processors provide an integrated high performance fast path multilayer solution for both intrusion protection
and firewall functions. The multilayered protection starts from anomaly checking at packet level to ensure each
packet is sound and reasonable. Immediately after that, a sophisticated set of interface based packet anomaly
protection, DDoS protection, policy based intrusion protection, firewall fast path, and behavior based methods
are employed to prevent DDoS attacks from the rest of system.

Then the packets enter an interface/policy based intrusion protection system,

where each packet is evaluated against a set of signatures. The end result is streams of user packets that are free
of anomaly and attacks, entering the fast path system for unicast or multicast fast path forwarding.

SP processing flow

Displaying information about security processing modules

You can display information about installed SPmodules using the CLI command

diagnose npu spm

For example, for the FortiGate-5101C:

FG-5101C # diagnose npu spm list
Available SP Modules:

ID Model Slot Interface
0 xh0 built-in  port1, port2, port3, port4,
                        base1, base2, fabric1, fabric2
                        eth10, eth11, eth12, eth13
                        eth14, eth15, eth16, eth17
                        eth18, eth19
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You can also use this command to get more info about SP processing. This example shows how to display details
about how the module is processing sessions using the syn proxy.

diagnose npu spm dos synproxy <sp_id>

This is a partial output of the command:

Number of proxied TCP connections : 0
Number of working proxied TCP connections : 0
Number of retired TCP connections : 0
Number of valid TCP connections : 0
Number of attacks, no ACK from client : 0
Number of no SYN-ACK from server : 0
Number of reset by server (service not supportted): 0
Number of establised session timeout : 0
Client timeout setting : 3 Seconds
Server timeout setting : 3 Seconds

Network processors (NP1, NP2, NP3, NP4, NP4Lite, NP6 and NP6Lite)
FortiASIC network processors work at the interface level to accelerate traffic by offloading traffic from the main
CPU. Current models contain NP4, NP4Lite, NP6, and NP6lite network processors. Older FortiGate models
include NP1 network processors (also known as FortiAccel, or FA2) and NP2 network processors.

The traffic that can be offloaded, maximum throughput, and number of network interfaces supported by each
varies by processor model:

l NP6 supports offloading of most IPv4 and IPv6 traffic, IPsec VPN encryption, CAPWAP traffic, and multicast traffic.
The NP6 has a maximum throughput of 40 Gbps using 4 x 10 Gbps XAUI or Quad Serial Gigabit Media
Independent Interface (QSGMII) interfaces or 3 x 10 Gbps and 16 x 1 Gbps XAUI or QSGMII interfaces. For details
about the NP6 processor, see NP6 and NP6lite Acceleration on page 1603 and for information about FortiGate
models with NP6 processors, see FortiGate NP6 architectures on page 1625.

l NP6lite is similar to the NP6 but with a lower throughput and some functional limitations (for example, the NP6lite
does not offload CAPWAP traffic). The NP6lite has a maximum throughput of 10 Gbps using 2x QSGMII and 2x
Reduced gigabit media-independent interface (RGMII) interfaces. For details about the NP6 processor, see
NP6Lite processors on page 1605 and for information about FortiGate models with NP6 processors, see FortiGate
NP6lite architectures on page 1682.

l NP4 supports offloading of most IPv4 firewall traffic and IPsec VPN encryption. The NP4 has a capacity of 20 Gbps
through 2 x 10 Gbps interfaces. For details about NP4 processors, see NP4 and NP4Lite Acceleration on page 1685
and for information about FortiGate models with NP4 processors, see FortiGate NP4 architectures on page 1696.

l NP4lite is similar to the NP4 but with a lower throughput (but with about half the performance )and some functional
limitations.

l NP2 supports IPv4 firewall and IPsec VPN acceleration. The NP2 has a capacity of 2 Gbps through 2 x 10 Gbps
interfaces or 4 x 1 Gbps interfaces.

l NP1 supports IPv4 firewall and IPsec VPN acceleration with 2 Gbps capacity. The NP1 has a capacity of 2 Gbps
through 2 x 1 Gbps interfaces.
l The NP1 does not support frames greater than 1500 bytes. If your network uses jumbo frames, you may need

to adjust the MTU (Maximum Transmission Unit) of devices connected to NP1 ports. Maximum frame size for
NP2, NP4, and NP6 processors is 9216 bytes.

l For both NP1 and NP2 network processors, ports attached to a network processor cannot be used for firmware
installation by TFTP.
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Sessions that require proxy-based security features (for example, virus scanning, IPS,
application control and so on) are not fast pathed and must be processed by the CPU.
Sessions that require flow-based security features can be offloaded to NP4 or NP6
network processors if the FortiGate supports NTurbo.

Determining the network processors installed on your FortiGate unit

Use either of the following command to list the NP6 processors in your FortiGate unit:

get hardware npu np6 port-list
diagnose npu np6 port-list

Use either of the following command to list the NP6lite processors in your FortiGate unit:

get hardware npu np6lite port-list
diagnose npu np6lite port-list

To list other network processors on your FortiGate unit, use the following CLI command.

get hardware npu <model> list

<model> can be legacy, np1, np2 or np4.

The output lists the interfaces that have the specified processor. For example, for a FortiGate-5001B:

get hardware npu np4 list
ID Model Slot Interface
0 On-board port1 port2 port3 port4
                               fabric1 base1 npu0-vlink0 npu0-vlink1
1 On-board port5 port6 port7 port8
                               fabric2 base2 npu1-vlink0 npu1-vlink1

The npu0-vlink0, npu1-vlink1 etc interfaces are used for accelerating inter-VDOM links.

How NP hardware acceleration alters packet flow

NP hardware acceleration generally alters packet flow as follows:

1. Packets initiating a session pass to the FortiGate unit’s main processing resources (CPU).
2. The FortiGate unit assesses whether the session matches fast path (offload) requirements.

To be suitable for offloading, traffic must possess only characteristics that can be processed by the fast path. The
list of requirements depends on the processor, see NP6 session fast path requirements on page 1603 or NP4
session fast path requirements on page 1686.
If the session can be fast pathed, the FortiGate unit sends the session key or IPsec security association (SA) and
configured firewall processing action to the appropriate network processor.

3. Network processors continuously match packets arriving on their attached ports against the session keys and SAs
they have received.
l If a network processor’s network interface is configured to perform hardware accelerated anomaly checks, the

network processor drops or accepts packets that match the configured anomaly patterns. These checks are
separate from and in advance of anomaly checks performed by IPS, which is not compatible with network
processor offloading. See Offloading NP4 anomaly detection on page 1693.

l The network processor next checks for a matching session key or SA. If a matching session key or SA is found,
and if the packet meets packet requirements, the network processor processes the packet according to the
configured action and then sends the resulting packet. This is the actual offloading step. Performing this
processing on the NP processor improves overall performance because the NP processor is optimized for this
task. As well, overall FortiGate performance is improved because the CPU has fewer sessions to process.
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NP network processor packet flow

l If a matching session key or SA is not found, or if the packet does not meet packet requirements, the packet cannot
be offloaded. The network processor sends the data to the FortiGate unit’s CPU, which processes the packet.

Encryption and decryption of IPsec traffic originating from the FortiGate can utilize network processor encryption
capabilities.

Packet forwarding rates vary by the percentage of offloadable processing and the type of network processing
required by your configuration, but are independent of frame size. For optimal traffic types, network throughput
can equal wire speed.

NP processors and traffic logging and monitoring

Except for the NP6, network processors do not count offloaded packets, and offloaded packets are not logged by
traffic logging and are not included in traffic statistics and traffic log reports.

NP6 processors support per-session traffic and byte counters, Ethernet MIBmatching, and reporting through
messages resulting in traffic statistics and traffic log reporting.

Accelerated sessions on FortiView All Sessions page

When viewing sessions in the FortiView All Sessions console, NP4/ NP6 accelerated sessions are highlighted with
an NP4 or NP6 icon. The tooltip for the icon includes the NP processor type and the total number of accelerated
sessions.

You can also configure filtering to display FortiASIC sessions.
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NP session offloading in HA active-active configuration

Network processors can improve network performance in active-active (load balancing) high availability (HA)
configurations, even though traffic deviates from general offloading patterns, involving more than one network
processor, each in a separate FortiGate unit. No additional offloading requirements apply.

Once the primary FortiGate unit’s main processing resources send a session key to its network processor(s),
network processor(s) on the primary unit can redirect any subsequent session traffic to other cluster members,
reducing traffic redirection load on the primary unit’s main processing resources.

As subordinate units receive redirected traffic, each network processor in the cluster assesses and processes
session offloading independently from the primary unit. Session key states of each network processor are not part
of synchronization traffic between HAmembers.

Configuring NP HMAC check offloading

Hash-based Message Authentication Code (HMAC) checks offloaded to network processors by default. You can
enter the following command to disable this feature:

configure system global
set ipsec-hmac-offload disable

end

Software switch interfaces and NP processors

FortiOS supports creating a software switch by grouping two or more FortiGate physical interfaces into a single
virtual or software switch interface. All of the interfaces in this virtual switch act like interfaces in a hardware
switch in that they all have the same IP address and can be connected to the same network. You create a
software switch interface from the CLI using the command config system switch-interface.

The software switch is a bridge group of several interfaces, and the FortiGate CPUmaintains the mac-port table
for this bridge. As a result of this CPU involvement, traffic processed by a software switch interface is not
offloaded to network processors.

Disabling NP acceleration for individual IPsec VPN phase 1s

Use the following command to disable NP offloading for an interface-based IPsec VPN phase 1:

config vpn ipsec phase1-interface
edit phase-1-name

set npu-offload disable
end

Use the following command to disable NP offloading for a policy-based IPsec VPN phase 1:

config vpn ipsec phase1
edit phase-1-name

set npu-offload disable
end

The npu-offload option is enabled by default.

Disabling NP offloading for unsupported IPsec encryption or authentication algorithms

In general, more recent IPsec VPN encryption and authentication algorithmsmay not be supported by older NP
processors. For example, NP4 network processors do not support SHA-256, SHA-384, and SHA-512. IPsec traffic
with unsupported algorithms is not offloaded and instead is processed by the FortiGate CPU. In addition, this
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configuration may cause packet loss and other performance issues. If you experience packet loss or performance
problems you should set the npu-offload option to disable. Future FortiOS versions should prevent
selecting algorithms not supported by the hardware.

Disabling NP offloading for firewall policies

Use the following options to disable NP offloading for specific security policies:

For IPv4 security policies.

config firewall policy
edit 1

set auto-asic-offload disable
end

For IPv6 security policies.

config firewall policy6
edit 1

set auto-asic-offload disable
end

For multicast security policies.

config firewall multicast-policy
edit 1

set auto-asic-offload disable
end

Enabling strict protocol header checking disables all hardware acceleration
You can use the following command to cause the FortiGate to apply strict header checking to verify that a packet
is part of a session that should be processed. Strict header checking includes verifying the layer-4 protocol header
length, the IP header length, the IP version, the IP checksum, IP options, and verifying that ESP packets have the
correct sequence number, SPI, and data length.If the packet fails header checking it is dropped by the FortiGate
unit.

config system global
check-protocol-header strict

end

Enabling strict header checking disables all hardware acceleration. This includes NP, SP.and CP processing.

sFlow and NetFlow and hardware acceleration
NP6 offloading is supported when you configure NetFlow for interfaces connected to NP6 processors.

Configuring sFlow on any interface disables all NP4 and NP6 offloading for all traffic on that interface. As well,
configuring NetFlow on any interface disables NP4 offloading for all traffic on that interface.

Checking that traffic is offloaded by NP processors
A number of diagnose commands can be used to verify that traffic is being offloaded.

Using the packet sniffer

Use the packet sniffer to verify that traffic is offloaded. Offloaded traffic is not picked up by the packet sniffer so if
you are sending traffic through the FortiGate unit and it is not showing up on the packet sniffer you can conclude
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that it is offloaded.

diag sniffer packet port1 <option>

If you want the packet sniffer to be able to see offloaded traffic you can temporarily
disable offloading the traffic, run the packet sniffer to view it and then re-enable
offloading. As an example, you may want to sniff the traffic that is accepted by a
specific firewall policy. You can edit the policy and set the auto-asic-offload
option to disable to disable offloading this traffic.You can also disable offloading for
IPsec VPN traffic, see Disabling NP acceleration for individual IPsec VPN phase 1s on
page 1597.

Checking the firewall session offload tag

Use the diagnose sys session list command to display sessions. If the output for a session includes
the npu info field you should see information about session being offloaded. If the output doesn’t contain an
npu info field then the session has not been offloaded.

diagnose sys session list
session info: proto=6 proto_state=01 duration=34 expire=3565 timeout=3600

flags=00000000 sockflag=00000000 sockport=0 av_idx=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/
state=may_dirty npu
statistic(bytes/packets/allow_err): org=295/3/1 reply=60/1/1 tuples=2
orgin->sink: org pre->post, reply pre->post dev=48->6/6->48 gwy=10.1.100.11/11.11.11.1
hook=pre dir=org act=noop 172.16.200.55:56453->10.1.100.11:80(0.0.0.0:0)
hook=post dir=reply act=noop 10.1.100.11:80->172.16.200.55:56453(0.0.0.0:0)
pos/(before,after) 0/(0,0), 0/(0,0)
misc=0 policy_id=1 id_policy_id=0 auth_info=0 chk_client_info=0 vd=4
serial=0000091c tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
per_ip_bandwidth meter: addr=172.16.200.55, bps=393
npu_state=00000000
npu info: flag=0x81/0x81, offload=4/4, ips_offload=0/0, epid=1/23, ipid=23/1,

vlan=32779/0

Verifying IPsec VPN traffic offloading

The following commands can be used to verify IPsec VPN traffic offloading to NP processors.

diagnose vpn ipsec status
NPl/NP2/NP4_0/sp_0_0:

null: 0 0
des: 0 0
3des: 4075 4074
aes: 0 0
aria: 0 0
seed: 0 0
null: 0 0
md5: 4075 4074
sha1: 0 0
sha256: 0 0
sha384: 0 0
sha512: 0 0
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diagnose vpn tunnel list
list all ipsec tunnel in vd 3
------------------------------------------------------
name=p1-vdom1 ver=1 serial=5 11.11.11.1:0->11.11.11.2:0 lgwy=static tun=tunnel

mode=auto bound_if=47
proxyid_num=1 child_num=0 refcnt=8 ilast=2 olast=2
stat: rxp=3076 txp=1667 rxb=4299623276 txb=66323
dpd: mode=active on=1 idle=5000ms retry=3 count=0 seqno=20
natt: mode=none draft=0 interval=0 remote_port=0
proxyid=p2-vdom1 proto=0 sa=1 ref=2 auto_negotiate=0 serial=1
src: 0:0.0.0.0/0.0.0.0:0
dst: 0:0.0.0.0/0.0.0.0:0
SA: ref=6 options=0000000e type=00 soft=0 mtu=1436 expire=1736 replaywin=2048 seqno=680
life: type=01 bytes=0/0 timeout=1748/1800
dec: spi=ae01010c esp=3des key=24 18e021bcace225347459189f292fbc2e4677563b07498a07
ah=md5 key=16 b4f44368741632b4e33e5f5b794253d3
enc: spi=ae01010d esp=3des key=24 42c94a8a2f72a44f9a3777f8e6aa3b24160b8af15f54a573
ah=md5 key=16 6214155f76b63a93345dcc9ec02d6415
dec:pkts/bytes=3073/4299621477, enc:pkts/bytes=1667/66375
npu_flag=03 npu_rgwy=11.11.11.2 npu_lgwy=11.11.11.1 npu_selid=4

diagnose sys session list
session info: proto=6 proto_state=01 duration=34 expire=3565 timeout=3600

flags=00000000 sockflag=00000000 sockport=0 av_idx=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/p1-vdom2
state=re may_dirty npu
statistic(bytes/packets/allow_err): org=112/2/1 reply=112/2/1 tuples=2
orgin->sink: org pre->post, reply pre->post dev=57->7/7->57 gwy=10.1.100.11/11.11.11.1
hook=pre dir=org act=noop 172.16.200.55:35254->10.1.100.11:80(0.0.0.0:0)
hook=post dir=reply act=noop 10.1.100.11:80->172.16.200.55:35254(0.0.0.0:0)
pos/(before,after) 0/(0,0), 0/(0,0)
misc=0 policy_id=1 id_policy_id=0 auth_info=0 chk_client_info=0 vd=4
serial=00002d29 tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
per_ip_bandwidth meter: addr=172.16.200.55, bps=260
npu_state=00000000
npu info: flag=0x81/0x82, offload=7/7, ips_offload=0/0, epid=1/3, ipid=3/1,

vlan=32779/0

Dedicated Management CPU
The web-based manager and CLI of FortiGate units with NP6 and NP4 processors may become unresponsive
when the system is under heavy processing load because NP6 or NP4 interrupts overload the CPUs preventing
CPU cycles from being used for management tasks. You can resolve this issue by using the following command
to dedicate CPU core 0 to management tasks.

config system npu
set dedicated-management-cpu {enable | disable}

end

All management tasks are then processed by CPU 0 and NP6 or NP4 interrupts are handled by the remaining
CPU cores.
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Offloading flow-based content inspection with NTurbo and IPSA
You can use the following command to configure NTurbo and IPA Advanced (IPSA) offloading and acceleration of
firewall sessions that have flow-based security profiles. This includes firewall sessions with IPS, application
control, CASI, flow-based antivirus and flow-based web filtering.

config ips global
set np-accel-mode {none | basic}
set cp-accel-mode {none | basic | advanced}

end

NTurbo offloads firewall sessions with flow-based security profiles to NPx processors

NTurbo offloads firewall sessions that include flow-based security profiles to NP4 or NP6 network processors.
Without NTurbo, or with NTurbo disabled, all firewall sessions that include flow-based security profiles are
processed by the FortiGate CPU.

NTurbo can only offload firewall sessions containing flow-based security profiles if the
session could otherwise have been offloaded except for the presence of the flow-
based security profiles. If something else prevents the session from being offloaded,
NTurbo will not offload that session.

Firewall sessions that include proxy-based security profiles are never offloaded to
network processors and are always processed by the FortiGate CPU.

NTurbo creates a special data path to redirect traffic from the ingress interface to IPS, and from IPS to the egress
interface. NTurbo allows firewall operations to be offloaded along this path, and still allows IPS to behave as a
stage in the processing pipeline, reducing the workload on the FortiGate CPU and improving overall throughput.

NTurbo sessions still offload pattern matching and other processes to CP processors,
just like normal flow-based sessions.

If NTurbo is supported by your FortiGate unit, you can use the following command to configure it:

config ips global
set np-accel-mode {basic | none}

end

basic enables NTurbo and is the default setting for FortiGate models that support NTurbo. none disables
NTurbo. If the np-accel-mode option is not available, then your FortiGate does not support NTurbo.

There are some special cases where sessions may not be offloaded by NTurbo, even when NTurbo is explicitly
enabled. In these cases the sessions are handled by the FortiGate CPU.

l NP acceleration is disabled. For example, auto-asic-offload is disabled in the firewall policy configuration.
l The firewall policy includes proxy-based security profiles.
l The sessions require FortiOS session-helpers. For example, FTP sessions can not be offloaded to NP processors

because FTP sessions use the FTP session helper.
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l Interface policies or DoS policies have been added to the ingress or egress interface.
l Tunneling is enabled. Any traffic to or from a tunneled interface (IPSec, IPinIP, SSL VPN, GRE, CAPWAP, etc.)

cannot be offloaded by NTurbo.

IPSA offloads flow-based advanced pattern matching to CPx processors

IPSA offloads advanced or enhanced pattern matching operations required for flow-based content processing to
CP8 and CP9 Content Processors. IPSA offloads enhanced pattern matching for NTurbo firewall sessions and
firewall sessions that are not offloaded to NP processors. When IPSA is turned on, flow-based pattern databases
are compiled and downloaded to the content processors from the IPS engine and IPS database. Flow-based
pattern matching requests are redirected to the CP hardware reducing the load on the FortiGate CPU and
accelerating pattern matching.

IF IPSA is supported on your FortiGate unit, you can use the following command to configure it:

config ips global
set cp-accel-mode {advanced | basic | none}

end

basic offloads basic pattern matching. advanced offloads more types of pattern matching resulting in higher
throughput than basic mode. advanced is only available on FortiGate models with two or more CP8s or one or
more CP9s. If the cp-accel-mode option is not available, then your FortiGate does not support IPSA.

On FortiGates with one CP8, the default cp-accel-mode is basic. Setting the mode to advanced does not
change the types of pattern matching that are offloaded.

On FortiGates with two or more CP8s or one or more CP9s the default cp-accel-mode is advanced. You can
set the mode to basic to offload fewer types of pattern matching.

Preventing packet ordering problems with NP4, NP6 and NP6lite FortiGates under heavy
load

In some cases when FortiGate units with NP4, NP6, or NP6lite processors are under heavy load the packets used
in the TCP 3-way handshake of some sessions may be transmitted by the FortiGate in the wrong order resulting
in the TCP sessions failing.

If you notice TCP sessions failing when a FortiGate with NP4, NP6, or NP6lite processors is very busy you can
enable delay-tcp-npu-session in the firewall policy receiving the traffic. This option resolves the problem
by delaying the session to make sure that there is time for all of the handshake packets to reach the destination
before the session begins transmitting data.

config firewall policy
set delay-tcp-npu-session enable

end
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NP6 and NP6lite Acceleration

NP6 and NP6lite network processors provide fastpath acceleration by offloading communication sessions from
the FortiGate CPU. When the first packet of a new session is received by an interface connected to an NP6
processor, just like any session connecting with any FortiGate interface, the session is forwarded to the FortiGate
CPU where it is matched with a security policy. If the session is accepted by a security policy and if the session
can be offloaded its session key is copied to the NP6 processor that received the packet. All of the rest of the
packets in the session are intercepted by the NP6 processor and fast-pathed out of the FortiGate unit to their
destination without ever passing through the FortiGate CPU. The result is enhanced network performance
provided by the NP6 processor plus the network processing load is removed from the CPU. In addition the NP6
processor can handle some CPU intensive tasks, like IPsec VPN encryption/decryption.

NP6lite processors have the same architecture and function in the same way as NP6
processors. See NP6Lite processors on page 1605. All of the descriptions of NP6
processors in this document can be applied to NP6lite possessors except where noted.

Session keys (and IPsec SA keys) are stored in the memory of the NP6 processor that is connected to the
interface that received the packet that started the session. All sessions are fast-pathed and accelerated, even if
they exit the FortiGate unit through an interface connected to another NP6. There is no dependence on getting
the right pair of interfaces since the offloading is done by the receiving NP6.

The key to making this possible is an Integrated Switch Fabric (ISF) that connects the NP6s and the FortiGate
unit interfaces together. Many FortiGate units with NP6 processors also have an ISF. The ISF allows any port
connectivity. All ports and NP6s can communicate with each other over the ISF. There are no special ingress and
egress fast path requirements as long as traffic enters and exits on interfaces connected to the same ISF.

Some FortiGate units, such as the FortiGate-1000D include multiple NP6 processors that are not connected by
an ISF. Because the ISF is not present fast path acceleration is supported only between interfaces connected to
the same NP6 processor. Since the ISF introduces some latency, models with no ISF provide low-latency network
acceleration between network interfaces connected to the same NP6 processor.

Each NP6 has a maximum throughput of 40 Gbps using 4 x 10 Gbps XAUI or Quad Serial Gigabit Media
Independent Interface (QSGMII) interfaces or 3 x 10 Gbps and 16 x 1 Gbps XAUI or QSGMII interfaces.

There are at least two limitations to keep in mind:

l The capacity of each NP6 processor. An individual NP6 processor can support between 10 and 16 million sessions.
This number is limited by the amount of memory the processor has. Once an NP6 processor hits its session limit,
sessions that are over the limit are sent to the CPU. You can avoid this problem by as much as possible distributing
incoming sessions evenly among the NP6 processors. To be able to do this you need to be aware of which
interfaces connect to which NP6 processors and distribute incoming traffic accordingly.

l The NP6 processors in some FortiGate units employ NP direct technology that removes the ISF. The result is very
low latency but no inter-processor connectivity requiring you to make sure that traffic to be offloaded enters and
exits the FortiGate through interfaces connected to the same NP processor.

NP6 session fast path requirements
NP6 processors can offload the following traffic and services:
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l IPv4 and IPv6 traffic and NAT64 and NAT46 traffic (as well as IPv4 and IPv6 versions of the following traffic types
where appropriate).

l Link aggregation (LAG) (IEEE 802.3ad) traffic and traffic from static redundant interfaces (see Increasing NP6
offloading capacity using link aggregation groups (LAGs) on page 1609).

l TCP, UDP, ICMP and SCTP traffic.
l IPsec VPN traffic, and offloading of IPsec encryption/decryption (including SHA2-256 and SHA2-512)
l NP6 processor IPsec engines support null, DES, 3DES, AES128, AES192, and AES256 encryption algorithms
l NP6 processor IPsec engines support null, MD5, SHA1, SHA256, SHA 384, and SHA512 authentication algorithms
l IPsec traffic that passes through a FortiGate without being unencrypted.
l Anomaly-based intrusion prevention, checksum offload and packet defragmentation .
l IPIP tunneling (also called IP in IP tunneling), SIT tunneling, and IPv6 tunneling sessions.
l Multicast traffic (including Multicast over IPsec).
l CAPWAP and wireless bridge traffic tunnel encapsulation to enable line rate wireless forwarding from FortiAP

devices (not supported by the NP6lite).
l Traffic shaping and priority queuing for both shared and per IP traffic shaping.
l Syn proxying (not supported by the NP6lite).
l DNS session helper (not supported by the NP6lite).
l Inter-VDOM link traffic.

Sessions that are offloaded must be fast path ready. For a session to be fast path ready it must meet the
following criteria:

l Layer 2 type/length must be 0x0800 for IPv4 or 0x86dd for IPv6 (IEEE 802.1q VLAN specification is supported)
l Layer 3 protocol can be IPv4 or IPv6
l Layer 4 protocol can be UDP, TCP, ICMP, or SCTP
l In most cases, Layer 3 / Layer 4 header or content modification sessions that require a session helper can be

offloaded.
l Local host traffic (originated by the FortiGate unit) can be offloaded
l If the FortiGate supports, NTurbo sessions can be offloaded if they are accepted by firewall policies that include

IPS, Application Control, CASI, flow-based antivirus, or flow-based web filtering.

Offloading Application layer content modification is not supported. This means that sessions are not offloaded if
they are accepted by firewall policies that include proxy-based virus scanning, proxy-based web filtering, DNS
filtering, DLP, Anti-Spam, VoIP, ICAP, Web Application Firewall, or Proxy options.

If you disable anomaly checks by Intrusion Prevention (IPS), you can still enable
hardware accelerated anomaly checks using the fp-anomaly field of the
config system interface CLI command. See Configuring individual NP6
processors on page 1614.

If a session is not fast path ready, the FortiGate unit will not send the session key or IPsec SA key to the NP6
processor. Without the session key, all session key lookup by a network processor for incoming packets of that
session fails, causing all session packets to be sent to the FortiGate unit’s main processing resources, and
processed at normal speeds.

If a session is fast path ready, the FortiGate unit will send the session key or IPsec SA key to the network
processor. Session key or IPsec SA key lookups then succeed for subsequent packets from the known session or
IPsec SA.
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Packet fast path requirements

Packets within the session must then also meet packet requirements.

l Incoming packets must not be fragmented.
l Outgoing packets must not require fragmentation to a size less than 385 bytes. Because of this requirement, the

configured MTU (Maximum Transmission Unit) for a network processor’s network interfaces must also meet or
exceed the network processors’ supported minimum MTU of 385 bytes.

Mixing fast path and non-fast path traffic

If packet requirements are not met, an individual packet will be processed by the FortiGate CPU regardless of
whether other packets in the session are offloaded to the NP6.

Also, in some cases, a protocol’s session(s) may receive a mixture of offloaded and non-offloaded processing.
For example, VoIP control packets may not be offloaded but VoIP data packets (voice packets) may be offloaded.

NP6Lite processors
The NP6Lite works the same way as the NP6. Being a lighter version, the NP6Lite has a lower capacity than the
NP6. The NP6lite max throughput is 10 Gbps using 2x QSGMII and 2x Reduced gigabit media-independent
interface (RGMII) interfaces.

Also, the NP6lite does not offload the following types of sessions:

l CAPWAP
l Syn proxy
l DNS session helper

NP6 and NP6Lite processors and sFlow and NetFlow
NP6 and NP6Lite offloading is supported when you configure NetFlow for interfaces connected to NP6 or NP6Lite
processors. Offloading of other sessions is not affected by configuring NetFlow.

Configuring sFlow on any interface disables all NP6 and NP6Lite offloading for all traffic on that interface.

NP6 processors and traffic shaping
NP6-offloaded sessions support most types of traffic shaping. However, in bandwidth and out bandwidth traffic
shaping, set using the following command, is not supported:

config system interface
edit port1

set outbandwidth <value>
set inbandwidth <value>

end

Configuring in bandwidth traffic shaping has no effect. Configuring out bandwidth traffic shaping imposes more
limiting than configured, potentially reducing throughput more than expected.
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NP Direct
On FortiGates with more than one NP6 processor, removing the Internal Switch Fabric (ISF) for NP Direct
architecture provides direct access to the NP6 processors for the lowest latency forwarding. Because the NP6
processors are not connected, care must be taken with network design to make sure that all traffic to be offloaded
enters and exits the FortiGate through interfaces connected to the same NP6 processor. As well Link Aggregation
(LAG) interfaces should only include interfaces all connected to the same NP6 processor.

Example NP direct hardware with more than one NP6 processor includes:

l Ports 25 to 32 of the FortiGate-3700D in low latency mode.
l FortiGate-2000E
l FortiGate-2500E

Viewing your FortiGate NP6 processor configuration
Use either of the following commands to view the NP6 processor hardware configuration of your FortiGate unit:

get hardware npu np6 port-list
diagnose npu np6 port-list

If your FortiGate has NP6lite processors, you can use either of the following commands:

get hardware npu np6lite port-list
diagnose npu np6lite port-list

For example, for the FortiGate-5001D the output would be:

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port3 10G Yes

1
2 base1 1G Yes
3
0-3 port1 40G Yes
0-3 fabric1 40G Yes
0-3 fabric3 40G Yes
0-3 fabric5 40G Yes

------ ---- ------- ----- ----------
np6_1 0

1 port4 10G Yes
2
3 base2 1G Yes
0-3 port2 40G Yes
0-3 fabric2 40G Yes
0-3 fabric4 40G Yes

------ ---- ------- ----- ----------

For more example output for different FortiGate models, see FortiGate NP6 architectures on page 1625 and
FortiGate NP6lite architectures on page 1682.

You can also use the following command to view the offloading features enabled or disabled on each of the NP6
processors in your FortiGate unit:
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diagnose npu npu-feature
np_0 np_1

------------------- --------- ---------
Fastpath Enabled Enabled
Low-latency-mode Disabled Disabled
Low-latency-cap No No
IPv4 firewall Yes Yes
IPv6 firewall Yes Yes
IPv4 IPSec Yes Yes
IPv6 IPSec Yes Yes
IPv4 tunnel Yes Yes
IPv6 tunnel Yes Yes
GRE tunnel No No
IPv4 Multicast Yes Yes
IPv6 Multicast Yes Yes
CAPWAP Yes Yes

Optimizing NP6 performance by distributing traffic to XAUI links
On most FortiGate units with NP6 processors, the FortiGate interfaces are switch ports that connect to the NP6
processors with XAUI links. Packets pass from the interfaces to the NP6 processor over the XAUI links. Each NP6
processor has a 40 Gigabit bandwidth capacity. The four XAUI links each have a 10 Gigabit capacity for a total of
40 Gigabits.

On many FortiGate units with NP6 processors, the NP6 processors and the XAUI links are over-subscribed. Since
the NP6 processors are connected by an Integrated Switch Fabric, you do not have control over how traffic is
distributed to them. In fact traffic is distributed evenly by the ISF.

However, you can control how traffic is distributed to the XAUI links and you can optimize performance by
distributing traffic evenly among the XAUI links. For example, if you have a very high amount of traffic passing
between two networks, you can connect each network to interfaces connected to different XAUI links to distribute
the traffic for each network to a different XAUI link.

For example, on a FortiGate-3200D (See FortiGate-3200D fast path architecture on page 1649), there are 48 10-
Gigabit interfaces that send and receive traffic for two NP6 processors over a total of eight 10-Gigabit XAUI links.
Each XAUI link gets traffic from six 10-Gigabit FortiGate interfaces. The amount of traffic that the FortiGate-
3200D can offload is limited by the number of NP6 processors and the number of XAUI links. You can optimize
the amount of traffic that the FortiGate-3200D can process by distributing it evenly amount the XAUI links and the
NP6 processors.

You can see the Ethernet interface, XAUI link, and NP6 configuration by entering the get hardware npu
np6 port-list command. For the FortiGate-3200D the output is:

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port1 10G Yes

0 port5 10G Yes
0 port10 10G Yes
0 port13 10G Yes
0 port17 10G Yes
0 port22 10G Yes
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1 port2 10G Yes
1 port6 10G Yes
1 port9 10G Yes
1 port14 10G Yes
1 port18 10G Yes
1 port21 10G Yes
2 port3 10G Yes
2 port7 10G Yes
2 port12 10G Yes
2 port15 10G Yes
2 port19 10G Yes
2 port24 10G Yes
3 port4 10G Yes
3 port8 10G Yes
3 port11 10G Yes
3 port16 10G Yes
3 port20 10G Yes
3 port23 10G Yes

------ ---- ------- ----- ----------
np6_1 0 port26 10G Yes

0 port29 10G Yes
0 port33 10G Yes
0 port37 10G Yes
0 port41 10G Yes
0 port45 10G Yes
1 port25 10G Yes
1 port30 10G Yes
1 port34 10G Yes
1 port38 10G Yes
1 port42 10G Yes
1 port46 10G Yes
2 port28 10G Yes
2 port31 10G Yes
2 port35 10G Yes
2 port39 10G Yes
2 port43 10G Yes
2 port47 10G Yes
3 port27 10G Yes
3 port32 10G Yes
3 port36 10G Yes
3 port40 10G Yes
3 port44 10G Yes
3 port48 10G Yes

------ ---- ------- ----- ----------

In this command output you can see that each NP6 has for four XAUI links (0 to 3) and that each XAUI link is
connected to six 10-gigabit Ethernet interfaces. To optimize throughput you should keep the amount of traffic
being processed by each XAUI port to under 10 Gbps. So for example, if you want to offload traffic from four 10-
gigabit networks you can connect these networks to Ethernet interfaces 1, 2, 3 and 4. This distributes the traffic
from each 10-Gigabit network to a different XAUI link. Also, if you wanted to offload traffic from four more 10-
Gigabit networks you could connect them to Ethernet ports 26, 25, 28, and 27. As a result each 10-Gigabit
network would be connected to a different XAUI link.
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Increasing NP6 offloading capacity using link aggregation groups (LAGs)
NP6 processors can offload sessions received by interfaces in link aggregation groups (LAGs) (IEEE 802.3ad). A
802.3ad Link Aggregation and it's management protocol, Link Aggregation Control Protocol (LACP) LAG
combines more than one physical interface into a group that functions like a single interface with a higher
capacity than a single physical interface. For example, you could use a LAG if you want to offload sessions on a
30 Gbps link by adding three 10-Gbps interfaces to the same LAG.

All offloaded traffic types are supported by LAGs, including IPsec VPN traffic. Just like with normal interfaces,
traffic accepted by a LAG is offloaded by the NP6 processor connected to the interfaces in the LAG that receive
the traffic to be offloaded. If all interfaces in a LAG are connected to the same NP6 processor, traffic received by
that LAG is offloaded by that NP6 processor. The amount of traffic that can be offloaded is limited by the capacity
of the NP6 processor.

If a FortiGate has two or more NP6 processors connected by an integrated switch fabric (ISF), you can use LAGs
to increase offloading by sharing the traffic load across multiple NP6 processors. You do this by adding physical
interfaces connected to different NP6 processors to the same LAG.

Adding a second NP6 processor to a LAG effectively doubles the offloading capacity of the LAG. Adding a third
further increases offloading. The actual increase in offloading capacity may not actually be doubled by adding a
second NP6 or tripled by adding a thrid. Traffic and load conditions and other factors may limit the actual
offloading result.

The increase in offloading capacity offered by LAGs and multiple NP6s is supported by the integrated switch
fabric (ISF) that allows multiple NP6 processors to share session information. Most FortiGate units with multiple
NP6 processors also have an ISF. However, FortiGate modules such as the 1000D, 2000E, and 2500E do not
have an ISF. If you attempt to add interfaces connected to different NP6 processors to a LAG the system displays
an error message.

There are also a few limitations to LAG NP6 offloading support for IPsec VPN:

l IPsec VPN anti-replay protection cannot be used if IPSec is configured on a LAG that has interfaces connected to
multiple NP6 processors.

l Because the encrypted traffic for one IPsec VPN tunnel has the same 5-tuple, the traffic from one tunnel can only
can be balanced to one interface in a LAG. This limits the maximum throughput for one IPsec VPN tunnel in an NP6
LAG group to 10Gbps.

NP6 processors and redundant interfaces
NP6 processors can offload sessions received by interfaces that are part of a redundant interface. You can
combine two or more physical interfaces into a redundant interface to provide link redundancy. Redundant
interfaces ensure connectivity if one physical interface, or the equipment on that interface, fails. In a redundant
interface, traffic travels only over one interface at a time. This differs from an aggregated interface where traffic
travels over all interfaces for distribution of increased bandwidth.

All offloaded traffic types are supported by redundant interfaces, including IPsec VPN traffic. Just like with normal
interfaces, traffic accepted by a redundant interface is offloaded by the NP6 processor connected to the
interfaces in the redundant interface that receive the traffic to be offloaded. If all interfaces in a redundant
interface are connected to the same NP6 processor, traffic received by that redundant interface is offloaded by
that NP6 processor. The amount of traffic that can be offloaded is limited by the capacity of the NP6 processor.

1609 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 14 - Hardware Acceleration NP6 and NP6lite Acceleration

If a FortiGate has two or more NP6 processors connected by an integrated switch fabric (ISF), you can create
redundant interfaces that include physical interfaces connected to different NP6 processors. However, with a
redundant interface, only one of the physical interfaces is processing traffic at any given time. So you cannot use
redundant interfaces to increase performance in the same way as you can with aggregate interfaces.

The ability to add redundnat interfaces connected to multiple NP6s is supported by the integrated switch fabric
(ISF) that allows multiple NP6 processors to share session information. Most FortiGate units with multiple NP6
processors also have an ISF. However, FortiGate models such as the 1000D, 2000E, and 2500E do not have an
ISF. If you attempt to add interfaces connected to different NP6 processors to a redundant interface the system
displays an error message.

Configuring Inter-VDOM link acceleration with NP6 processors
FortiGate units with NP6 processors include inter-VDOM links that can be used to accelerate inter-VDOM link
traffic.

l For a FortiGate unit with two NP6 processors there are two accelerated inter-VDOM links, each with two interfaces:
l npu0_vlink:

npu0_vlink0
npu0_vlink1

l npu1_vlink:
npu1_vlink0
npu1_vlink1

These interfaces are visible from the GUI and CLI. For a FortiGate unit with NP6 interfaces, enter the following
CLI command to display the NP6-accelerated inter-VDOM links:

get system interface
...
== [ npu0_vlink0 ]
name: npu0_vlink0 mode: static ip: 0.0.0.0 0.0.0.0 status: down netbios-forward: disable

type: physical sflow-sampler: disable explicit-web-proxy: disable explicit-ftp-proxy:
disable mtu-override: disable wccp: disable drop-overlapped-fragment: disable drop-
fragment: disable

== [ npu0_vlink1 ]
name: npu0_vlink1 mode: static ip: 0.0.0.0 0.0.0.0 status: down netbios-forward: disable

type: physical sflow-sampler: disable explicit-web-proxy: disable explicit-ftp-proxy:
disable mtu-override: disable wccp: disable drop-overlapped-fragment: disable drop-
fragment: disable

== [ npu1_vlink0 ]
name: npu1_vlink0 mode: static ip: 0.0.0.0 0.0.0.0 status: down netbios-forward: disable

type: physical sflow-sampler: disable explicit-web-proxy: disable explicit-ftp-proxy:
disable mtu-override: disable wccp: disable drop-overlapped-fragment: disable drop-
fragment: disable

== [ npu1_vlink1 ]
name: npu1_vlink1 mode: static ip: 0.0.0.0 0.0.0.0 status: down netbios-forward: disable

type: physical sflow-sampler: disable explicit-web-proxy: disable explicit-ftp-proxy:
disable mtu-override: disable wccp: disable drop-overlapped-fragment: disable drop-
fragment: disable

...

By default the interfaces in each inter-VDOM link are assigned to the root VDOM. To use these interfaces to
accelerate inter-VDOM link traffic, assign each interface in the pair to the VDOMs that you want to offload traffic
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between. For example, if you have added a VDOM named New-VDOM to a FortiGate unit with NP4 processors,
you can go to System > Network > Interfaces and edit the npu0-vlink1 interface and set the Virtual Domain
to New-VDOM. This results in an accelerated inter-VDOM link between root and New-VDOM. You can also do
this from the CLI:

config system interface
edit npu0-vlink1

set vdom New-VDOM
end

Using VLANs to add more accelerated Inter-VDOM links

You can add VLAN interfaces to the accelerated inter-VDOM links to create inter-VDOM links between more
VDOMs. For the links to work, the VLAN interfaces must be added to the same inter-VDOM link, must be on the
same subnet, and must have the same VLAN ID.

For example, to accelerate inter-VDOM link traffic between VDOMs named Marketing and Engineering using
VLANs with VLAN ID 100 go to System > Network > Interfaces and select Create New to create the VLAN
interface associated with the Marketing VDOM:

Name Marketing-link

Type VLAN

Interface npu0_vlink0

VLAN ID 100

Virtual Domain Marketing

IP/Network Mask 172.20.120.12/24

Create the inter-VDOM link associated with Engineering VDOM:

Name Engineering-link

Type VLAN

Interface npu0_vlink1

VLAN ID 100

Virtual Domain Engineering

IP/Network Mask 172.20.120.22/24

Or do the same from the CLI:

config system interface
edit Marketing-link

set vdom Marketing
set ip 172.20.120.12/24
set interface npu0_vlink0
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set vlanid 100
next
edit Engineering-link

set vdom Engineering
set ip 172.20.120.22/24
set interface npu0_vlink1
set vlanid 100

Confirm that the traffic is accelerated

Use the following CLI commands to obtain the interface index and then correlate them with the session entries.
In the following example traffic was flowing between new accelerated inter-VDOM links and physical ports port1
and port 2 also attached to the NP6 processor.

diagnose ip address list
IP=172.31.17.76->172.31.17.76/255.255.252.0 index=5 devname=port1
IP=10.74.1.76->10.74.1.76/255.255.252.0 index=6 devname=port2
IP=172.20.120.12->172.20.120.12/255.255.255.0 index=55 devname=IVL-VLAN1_ROOT
IP=172.20.120.22->172.20.120.22/255.255.255.0 index=56 devname=IVL-VLAN1_VDOM1

diagnose sys session list
session info: proto=1 proto_state=00 duration=282 expire=24 timeout=0 session info:

proto=1 proto_state=00 duration=124 expire=59 timeout=0 flags=00000000
sockflag=00000000 sockport=0 av_idx=0 use=3

origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/
state=may_dirty npu
statistic(bytes/packets/allow_err): org=180/3/1 reply=120/2/1 tuples=2
orgin->sink: org pre->post, reply pre->post dev=55->5/5->55

gwy=172.31.19.254/172.20.120.22
hook=post dir=org act=snat 10.74.2.87:768->10.2.2.2:8(172.31.17.76:62464)
hook=pre dir=reply act=dnat 10.2.2.2:62464->172.31.17.76:0(10.74.2.87:768)
misc=0 policy_id=4 id_policy_id=0 auth_info=0 chk_client_info=0 vd=0
serial=0000004e tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
per_ip_bandwidth meter: addr=10.74.2.87, bps=880
npu_state=00000000
npu info: flag=0x81/0x81, offload=8/8, ips_offload=0/0, epid=160/218, ipid=218/160,

vlan=32769/0

session info: proto=1 proto_state=00 duration=124 expire=20 timeout=0 flags=00000000
sockflag=00000000 sockport=0 av_idx=0 use=3

origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/
state=may_dirty npu
statistic(bytes/packets/allow_err): org=180/3/1 reply=120/2/1 tuples=2
orgin->sink: org pre->post, reply pre->post dev=6->56/56->6

gwy=172.20.120.12/10.74.2.87
hook=pre dir=org act=noop 10.74.2.87:768->10.2.2.2:8(0.0.0.0:0)
hook=post dir=reply act=noop 10.2.2.2:768->10.74.2.87:0(0.0.0.0:0)
misc=0 policy_id=3 id_policy_id=0 auth_info=0 chk_client_info=0 vd=1
serial=0000004d tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
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per_ip_bandwidth meter: addr=10.74.2.87, bps=880
npu_state=00000000
npu info: flag=0x81/0x81, offload=8/8, ips_offload=0/0, epid=219/161, ipid=161/219,

vlan=0/32769
total session 2

Disabling offloading IPsec Diffie-Hellman key exchange
You can use the following command to disable using ASIC offloading to accelerate IPsec Diffie-Hellman key
exchange for IPsec ESP traffic. By default hardware offloading is used. For debugging purposes or other reasons
you may want this function to be processed by software.

Use the following command to disable using ASIC offloading for IPsec Diffie Hellman key exchange:

config system global
set ipsec-asic-offload disable

end

Access control lists (ACLs)
Access Control Lists (ACLs) use NP6 offloading to drop IPv4 or IPv6 packets at the physical network interface
before the packets are analyzed by the CPU. On a busy appliance this can really help the performance. This
feature is available on FortiGates with NP6 processors and is not supported by FortiGates with NP6lite
processors.

The ACL feature is available only on FortiGates with NP6-accelerated interfaces. ACL checking is one of the first
things that happens to the packet and checking is done by the NP6 processor. The result is very efficient
protection that does not use CPU or memory resources.

Use the following command to configure IPv4 ACL lists:

config firewall acl
edit 0

set status enable
set interface <interface-name>
set scraddr <firewall-address>
set dstaddr <firewall-address>
set service <firewall-service>

end

Use the following command to configure IPv6 ACL lists:

config firewall acl6
edit 0

set status enable
set interface <interface-name>
set scraddr <firewall-address6>
set dstaddr <firewall-address6>
set service <firewall-service>

end

Where:

<interface-name> is the interface on which to apply the ACL. There is a hardware limitation that needs to be
taken into account. The ACL is a Layer 2 function and is offloaded to the ISF hardware, therefore no CPU
resources are used in the processing of the ACL. It is handled by the inside switch chip which can do hardware
acceleration, increasing the performance of the FortiGate. The ACL function is only supported on switch fabric
driven interfaces.

1613 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 14 - Hardware Acceleration NP6 and NP6lite Acceleration

<firewall-address> <firewall-address6> can be any of the address types used by the FortiGate,
including address ranges. The traffic is blocked not on an either or basis of these addresses but the combination
of the two, so that they both have to be correct for the traffic to be denied. To block all of the traffic from a specific
address all you have to do is make the destination address ALL.

Because the blocking takes place at the interface based on the information in the packet header and before any
processing such as NAT can take place, a slightly different approach may be required. For instance, if you are
trying to protect a VIP which has an external address of x.x.x.x and is forwarded to an internal address of y.y.y.y,
the destination address that should be used is x.x.x.x, because that is the address that will be in the packet's
header when it hits the incoming interface.

<firewall-service> the firewall service to block. Use ALL to block all services.

Configuring individual NP6 processors
You can use the config system np6 command to configure a wide range of settings for each of the NP6
processors in your FortiGate unit including enabling/disabling fastpath and low latency, enabling session
accounting and adjusting session timeouts. As well you can set anomaly checking for IPv4 and IPv6 traffic.

You can also enable and adjust Host Protection Engine (HPE) to protect networks from DoS attacks by
categorizing incoming packets based on packet rate and processing cost and applying packet shaping to packets
that can cause DoS attacks.

The settings that you configure for an NP6 processor with the config system np6 command apply to traffic
processed by all interfaces connected to that NP6 processor. This includes the physical interfaces connected to
the NP6 processor as well as all subinterfaces, VLAN interfaces, IPsec interfaces, LAGs and so on associated
with the physical interfaces connected to the NP6 processor.

Some of the options for this command apply anomaly checking for NP6 sessions in the
same way as the command described in Offloading NP4 anomaly detection on page
1693 applies anomaly checking for NP4 sessions.

config system np6
edit <np6-processor-name>

set fastpath {disable | enable}
set low-latency-mode {disable | enable}
set per-session-accounting {all-enable | disable | enable-by-log}
set session-timeout-random-range <range>
set garbage-session-collector {disable | enable}
set session-collector-interval <range>
set session-timeout-interval <range>
set session-timeout-random-range <range>
set session-timeout-fixed {disable | enable}

config hpe
set tcpsyn-max <packets-per-second>
set tcp-max <packets-per-second>
set udp-max <packets-per-second>
set icmp-max <packets-per-second>
set sctp-max <packets-per-second>
set esp-max <packets-per-second>
set ip-frag-max <packets-per-second>
set ip-others-max <packets-per-second>
set arp-max <packets-per-second>
set l2-others-max <packets-per-second>
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set enable-shaper {disable | enable}
config fp-anomaly

set tcp-syn-fin {allow | drop | trap-to-host}
set tcp_fin_noack {allow | drop | trap-to-host}
set tcp_fin_only {allow | drop | trap-to-host}
set tcp_no_flag {allow | drop | trap-to-host}
set tcp_syn_data {allow | drop | trap-to-host}
set tcp-winnuke {allow | drop | trap-to-host}
set tcp-land {allow | drop | trap-to-host}
set udp-land {allow | drop | trap-to-host}
set icmp-land {allow | drop | trap-to-host}
set icmp-frag {allow | drop | trap-to-host}
set ipv4-land {allow | drop | trap-to-host}
set ipv4-proto-err {allow | drop | trap-to-host}
set ipv4-unknopt {allow | drop | trap-to-host}
set ipv4-optrr {allow | drop | trap-to-host}
set ipv4-optssrr {allow | drop | trap-to-host}
set ipv4-optlsrr {allow | drop | trap-to-host}
set ipv4-optstream {allow | drop | trap-to-host}
set ipv4-optsecurity {allow | drop | trap-to-host}
set ipv4-opttimestamp {allow | drop | trap-to-host}
set ipv4-csum-err {drop | trap-to-host}
set tcp-csum-err {drop | trap-to-host}
set udp-csum-err {drop | trap-to-host}
set icmp-csum-err {drop | trap-to-host}
set ipv6-land {allow | drop | trap-to-host}
set ipv6-proto-err {allow | drop | trap-to-host}
set ipv6-unknopt {allow | drop | trap-to-host}
set ipv6-saddr-err {allow | drop | trap-to-host}
set ipv6-daddr-err {allow | drop | trap-to-host}
set ipv6-optralert {allow | drop | trap-to-host}
set ipv6-optjumbo {allow | drop | trap-to-host}
set ipv6-opttunnel {allow | drop | trap-to-host}
set ipv6-opthomeaddr {allow | drop | trap-to-host}
set ipv6-optnsap {allow | drop | trap-to-host}
set ipv6-optendpid {allow | drop | trap-to-host}
set ipv6-optinvld {allow | drop | trap-to-host}

end

Command syntax

Command Description Default

fastpath {disable |
enable}

Enable fastpath acceleration to offload sessions to
the NP6 processor. You can disable fastpath if you
don’t want the NP6 processor to offload sessions.

enable

low-latency-mode {disable
| enable}

Enable low-latency mode. In low latency mode the
integrated switch fabric is bypassed. Low latency
mode requires that packet enter and exit using the
same NP6 processor. This option is only available for
NP6 processors that can operate in low-latency
mode, currently only np6_0 and np6_1 on the
FortiGate-3700D and DX.

disable
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Command Description Default

per-session-accounting
{all-enable | disable |
enable-by-log}

Disable NP6 per-session accounting or enable it and
control how it works. If set to enable-by-log (the
default) NP6 per-session accounting is only enabled
if firewall policies accepting offloaded traffic have
traffic logging enabled. If set to all-enable, NP6
per-session accounting is always enabled for all
traffic offloaded by the NP6 processor.

Enabling per-session accounting can affect
performance.

enable-by-log

garbage-session-collector
{disable | enable} Enable deleting expired or garbage sessions. disable

session-collector-
interval <range>

Set the expired or garbage session collector time
interval in seconds. The range is 1 to 100 seconds.

64

session-timeout-interval
<range>

Set the timeout for checking for and removing
inactive NP6 sessions. The range is 0 to 1000
seconds.

40

session-timeout-random-
range <range>

Set the random timeout for checking and removing
inactive NP6 sessions. The range is 0 to 1000
seconds.

8

session-timeout-fixed
{disable | enable}

Enable to force checking for and removing inactive
NP6 sessions at the session-timeout-
interval time interval. Set to disable (the default)
to check for and remove inactive NP6 sessions at
random time intervals.

disable

config hpe

hpe

Use the following options to use HPE to apply DDoS protection at the
NP6 processor by limiting the number packets per second received
for various packet types by each NP6 processor. This rate limiting is
applied very efficiently because it is done in hardware by the NP6
processor.

enable-shaper {disable |
enable}

Enable or disable HPEDDoS protection. disable

tcpsyn-max

Limit the maximum number of TCP SYN packets
received per second. The range is 10,000 to
4,000,000,000 pps. The default limits the number of
packets per second to 5,000,000 pps.

5000000
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Command Description Default

tcp-max Limit the maximum number of TCP packets received
per second. The range is 10,000 to 4,000,000,000
pps. The default limits the number of packets per
second to 5,000,000 pps.

5000000

udp-max

Limit the maximum number of UDP packets received
per second. The range is 10,000 to 4,000,000,000
pps. The default limits the number of packets per
second to 5,000,000 pps.

5000000

icmp-max Limit the maximum number of ICMP packets
received. The range is 10,000 to 4,000,000,000 pps.
The default is 100,000 pps.

100000

sctp-max
Limit the maximum number of SCTP packets
received. The range is 10,000 to 4,000,000,000 pps.
The default is 100,000 pps.

100000

esp-max Limit the maximum number of ESP packets
received. The range is 10,000 to 4,000,000,000 pps.
The default is 100,000 pps.

100000

ip-frag-max
Limit the maximum number of fragmented IP
packets received. The range is 10,000 to
4,000,000,000 pps. The default is 100,000 pps.

100000

ip-others-max Limit the maximum number of other types of IP
packets received. The range is 10,000 to
4,000,000,000 pps. The default is 100,000 pps.

100000

arp-max
Limit the maximum number of ARP packets
received. The range is 10,000 to 4,000,000,000 pps.
The default is 100,000 pps.

100000

l2-others-max Limit the maximum number of other layer-2 packets
received. The range is 10,000 to 4,000,000,000 pps.
The default is 100,000 pps.

100000

config fp-anomaly

fp-anomaly Configure how the NP6 processor does traffic anomaly protection. In
most cases you can configure the NP6 processor to allow or drop the
packets associated with an attack or forward the packets that are
associated with the attack to FortiOS (called trap-to-host).
Selecting trap-to-host turns off NP6 anomaly protection for
that anomaly. If you require anomaly protection but don't want to use
the NP6 processor, you can select trap-to-host and enable
anomaly protection with a DoS policy.
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Command Description Default

tcp-syn-fin {allow | drop
| trap-to-host} Detects TCP SYN flood SYN/FIN flag set anomalies. allow

tcp_fin_noack {allow |
drop | trap-to-host}

Detects TCP SYN flood with FIN flag set without
ACK setting anomalies.

trap-to-host

tcp_fin_only {allow |
drop | trap-to-host}

Detects TCP SYN flood with only FIN flag set
anomalies. trap-to-host

tcp_no_flag {allow | drop
| trap-to-host}

Detects TCP SYN flood with no flag set anomalies. allow

tcp_syn_data {allow |
drop | trap-to-host}

Detects TCP SYN flood packets with data
anomalies. allow

tcp-winnuke {allow | drop
| trap-to-host}

Detects TCPWinNuke anomalies. trap-to-host

tcp-land {allow | drop |
trap-to-host} Detects TCP land anomalies. trap-to-host

udp-land {allow | drop |
trap-to-host}

Detects UDP land anomalies. trap-to-host

icmp-land {allow | drop |
trap-to-host} Detects ICMP land anomalies. trap-to-host

icmp-frag {allow | drop |
trap-to-host}

Detects Layer 3 fragmented packets that could be
part of a layer 4 ICMP anomalies.

allow

ipv4-land {allow | drop |
trap-to-host} Detects IPv4 land anomalies. trap-to-host

ipv4-proto-err {allow |
drop | trap-to-host}

Detects invalid layer 4 protocol anomalies. trap-to-host

ipv4-unknopt {allow |
drop | trap-to-host} Detects unknown option anomalies. trap-to-host

ipv4-optrr {allow | drop
| trap-to-host}

Detects IPv4 with record route option anomalies. trap-to-host

ipv4-optssrr {allow |
drop | trap-to-host}

Detects IPv4 with strict source record route option
anomalies. trap-to-host

ipv4-optlsrr {allow |
drop | trap-to-host}

Detects IPv4 with loose source record route option
anomalies.

trap-to-host
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Command Description Default

ipv4-optstream {allow |
drop | trap-to-host} Detects stream option anomalies. trap-to-host

ipv4-optsecurity {allow |
drop | trap-to-host}

Detects security option anomalies. trap-to-host

ipv4-opttimestamp {allow
| drop | trap-to-host} Detects timestamp option anomalies. trap-to-host

ipv4-csum-err {drop |
trap-to-host}

Detects IPv4 checksum errors. drop

tcp-csum-err {drop |
trap-to-host} Detects TCP chechsum errors. drop

udp-csum-err {drop |
trap-to-host}

Detects UDP chechsum errors. drop

icmp-csum-err {drop |
trap-to-host} Detects ICMP chechsum errors. drop

ipv6-land {allow | drop |
trap-to-host}

Detects IPv6 land anomalies trap-to-host

ipv6-unknopt {allow |
drop | trap-to-host} Detects unknown option anomalies. trap-to-host

ipv6-saddr-err {allow |
drop | trap-to-host}

Detects source address as multicast anomalies. trap-to-host

ipv6-daddr_err {allow |
drop | trap-to-host}

Detects destination address as unspecified or
loopback address anomalies. trap-to-host

ipv6-optralert {allow |
drop | trap-to-host}

Detects router alert option anomalies. trap-to-host

ipv6-optjumbo {allow |
drop | trap-to-host} Detects jumbo options anomalies. trap-to-host

ipv6-opttunnel {allow |
drop | trap-to-host}

Detects tunnel encapsulation limit option anomalies. trap-to-host

ipv6-opthomeaddr {allow |
drop | trap-to-host} Detects home address option anomalies. trap-to-host

ipv6-optnsap {allow |
drop | trap-to-host}

Detects network service access point address option
anomalies.

trap-to-host
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Command Description Default

ipv6-optendpid {allow |
drop | trap-to-host} Detects end point identification anomalies. trap-to-host

ipv6-optinvld {allow |
drop | trap-to-host}

Detects invalid option anomalies. trap-to-host

Enabling per-session accounting for offloaded NP6 or NP6lite sessions
Per-session accounting is a logging feature that allows the FortiGate to report the correct bytes/pkt numbers per
session for sessions offloaded to an NP6 or NP6lite processor. This information appears in traffic log messages
as well as in FortiView. The following example shows the Sessions dashboard widget tracking SPU and nTurbo
sessions. Current sessions shows the total number of sessions, SPU shows the percentage of these sessions
that are SPU sessions and Nturbo shows the percentage that are nTurbo sessions.

You can hover over the SPU icon to see some information about the offloaded sessions.

You configure per-session accounting for each NP6 processor. For example, use the following command to
enable per-session accounting for NP6_0 and NP6_1:

config system np6
edit np6_0

set per-session-accounting enable-by-log
next
edit np6_1

set per-session-accounting enable-by-log
end

If your FortiGate has NP6lite processors, you can use the following command to enable per-session accounting
for all of the NP6lite processors in the FortiGate unit:

config system npu
set per-session-accounting enable-by-log

end
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The option, enable-by-log enables per-session accounting for offloaded sessions with traffic logging enabled
and all-enable enables per-session accounting for all offloaded sessions.

By default, per-session-accounting is set to enable-by-log, which results in per-session accounting
being turned on when you enable traffic logging in a policy.

Per-session accounting can affect offloading performance. So you should only enable per-session accounting if
you need the accounting information.

Enabling per-session accounting does not provide traffic flow data for sFlow or NetFlow.

Configuring NP6 session timeouts
For NP6 traffic, FortiOS refreshes an NP6 session's lifetime when it receives a session update message from the
NP6 processor. To avoid session update message congestion, these NP6 session checks are performed all at
once after a random time interval and all of the update messages are sent from the NP6 processor to FortiOS at
once. This can result in fewer messages being sent because they are only sent at random time intervals instead
of every time a session times out.

In fact, if your NP6 processor is processing a lot of short lived sessions, it is recommended that you use the
default setting of random checking every 8 seconds to avoid very bursty session updates. If the time between
session updates is very long and very many sessions have been expired between updates a large number of
updates will need to be done all at once.

You can use the following command to set the random time range.

config system np6
edit <np6-processor-name>

set session-timeout-fixed disable
set session-timeout-random-range 8

end

This is the default configuration. The random timeout range is 1 to 1000 seconds and the default range is 8. So,
by default, NP6 sessions are checked at random time intervals of between 1 and 8 seconds. So sessions can be
inactive for up to 8 seconds before they are removed from the FortiOS session table.

If you want to reduce the amount of checking you can increase the session-timeout-random-range. This
could result in inactive sessions being kept in the session table longer. But if most of your NP6 sessions are
relatively long this shouldn't be a problem.

You can also change this session checking to a fixed time interval and set a fixed timeout:

config system np6
edit <np6-processor-name>

set session-timeout-fixed enable
set session-timeout-fixed 40

end

The fixed timeout default is every 40 seconds and the rang is 1 to 1000 seconds. Using a fixed interval further
reduces the amount of checking that occurs.

You can select random or fixed updates and adjust the time intervals to minimize the refreshing that occurs while
still making sure inactive sessions are deleted regularly. For example, if an NP6 processor is processing sessions
with long lifetimes you can reduce checking by setting a relatively long fixed timeout.
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Configure the number of IPsec engines NP6 processors use
NP6 processors use multiple IPsec engines to accelerate IPsec encryption and decryption. In some cases out of
order ESP packets can cause problems if multiple IPsec engines are running. To resolve this problem you can
configure all of the NP6 processors to use fewer IPsec engines.

Use the following command to change the number of IPsec engines used for decryption (ipsec-dec-
subengine-mask) and encryption (ipsec-enc-subengine-mask). These settings are applied to all of the
NP6 processors in the FortiGate unit.

config system npu
set ipsec-dec-subengine-mask <engine-mask>
set ipsec-enc-subengine-mask <engine-mask>

end

<engine-mask> is a hexadecimal number in the range 0x01 to 0xff where each bit represents one IPsec
engine. The default <engine-mask> for both options is 0xff which means all IPsec engines are used. Add a
lower <engine-mask> to use fewer engines. You can configure different engine masks for encryption and
decryption.

Stripping clear text padding and IPsec session ESP padding
In some situations, when clear text or ESP packets in IPsec sessions may have large amounts of layer 2 padding,
the NP6 IPsec engine may not be able to process them and the session may be blocked.

If you notice dropped IPsec sessions, you could try using the following CLI options to cause the NP6 processor to
strip clear text padding and ESP padding before send the packets to the IPsec engine. With padding stripped, the
session can be processed normally by the IPsec engine.

Use the following command to strip ESP padding:

config system npu
set strip-esp-padding enable
set strip-clear-text-padding enable

end

Stripping clear text and ESP padding are both disabled by default.

Disable NP6 CAPWAP offloading
By default and where possible, managed FortiAP and FortiLink CAPWAP sessions are offloaded to NP6
processors. You can use the following command to disable CAWAP session offloading:

config system npu
set capwap-offload disable

end

Optionally disable NP6 offloading of traffic passing between 10Gbps and 1Gbps interfaces
Due to NP6 internal packet buffer limitations, some offloaded packets received at a 10Gbps interface and
destined for a 1Gbps interface can be dropped, reducing performance for TCP and IP tunnel traffic. If you
experience this performance reduction, you can use the following command to disable offloading sessions
passing from 10Gbps interfaces to 1Gbps interfaces:

config system npu
set host-shortcut-mode host-shortcut
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end

Select host-shortcut to stop offloading TCP and IP tunnel packets passing from 10Gbps interfaces to 1Gbps
interfaces. TCP and IP tunnel packets passing from 1Gbps interfaces to 10Gbps interfaces are still offloaded as
normal.

If host-shortcut is set to the default bi-directional setting, packets in both directions are offloaded.

This option is only available if your FortiGate has 10G and 1G interfaces accelerated by NP6 processors.

Enabling bandwidth control between the ISF and NP6 XAUI ports
In some cases, the Internal Switch Fabric (ISF) buffer size may be larger than the buffer size of an NP6 XAUI port
that receives traffic from the ISF. If this happens, burst traffic from the ISF may exceed the capacity of an XAUI
port and sessions may be dropped.

You can use the following command to configure bandwidth control between the ISF and XAUI ports. Enabling
bandwidth control can smooth burst traffic and keep the XAUI ports from getting overwhelmed and dropping
sessions.

Use the following command to enable bandwidth control:

config system npu
set sw-np-bandwidth {0G | 2G | 4G | 5G | 6G}

end

The default setting is 0G which means no bandwidth control. The other options limit the bandwidth to 2Gbps,
4Gbps and so on.

NP6 session drift
In some cases, sessions processed by NP6 processors may fail to be deleted leading to a large number of idle
sessions. This is called session drift. You can use SNMP to be alerted when the number of idle sessions becomes
high. SNMP also allows you to see which NP6 processor has the abnormal number of idle sessions and you can
use a diagnose command to delete them.

The following MIB fields allow you to use SNMP to monitor session table information for NP6 processors
including drift for each NP6 processor:

FORTINET-FORTIGATE-MIB::fgNPUNumber.0 = INTEGER: 2
FORTINET-FORTIGATE-MIB::fgNPUName.0 = STRING: NP6
FORTINET-FORTIGATE-MIB::fgNPUDrvDriftSum.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUIndex.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUIndex.1 = INTEGER: 1
FORTINET-FORTIGATE-MIB::fgNPUSessionTblSize.0 = Gauge32: 33554432
FORTINET-FORTIGATE-MIB::fgNPUSessionTblSize.1 = Gauge32: 33554432
FORTINET-FORTIGATE-MIB::fgNPUSessionCount.0 = Gauge32: 0
FORTINET-FORTIGATE-MIB::fgNPUSessionCount.1 = Gauge32: 0
FORTINET-FORTIGATE-MIB::fgNPUDrvDrift.0 = INTEGER: 0
FORTINET-FORTIGATE-MIB::fgNPUDrvDrift.1 = INTEGER: 0

You can also use the following diagnose command to determine of drift is occurring:

diagnose npu np6 sse-drift-summary
NPU drv-drift
----- ---------
np6_0 0
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np6_1 0
----- ---------
Sum 0
----- ---------

The command output shows a drift summary for all the NP6 processors in the system, and shows the total drift.
Normally the sum is 0. The previous command output, from a FortiGate-1500D, shows that the 1500D's two NP6
processors are not experiencing any drift.

If the sum is not zero, then extra idle sessions may be accumulating. You can use the following command to
delete those sessions:

diagnose npu np6 sse-purge-drift <np6_id> [<time>]

Where <np6_id> is the number (starting with NP6_0 with a np6_id of 0) of the NP6 processor for which to delete
idle sessions in. <time> is the age in seconds of the idle sessions to be deleted. All idle sessions this age and
older are deleted. The default time is 300 seconds.

The diagnose npu np6 sse-stats <np6_id> command output also includes a drv-drift field that
shows the total drift for one NP6 processor.
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FortiGate NP6 architectures

This chapter shows the NP6 architecture for the all FortiGate models that include NP6 processors.

FortiGate-300D fast path architecture
The FortiGate-300D includes one NP6 processor connected to four 1Gb RJ-45 Ethernet ports (port1-4) and four
1Gb SFP interfaces (port5-port8).

FortiASIC

NP6

CPUCP8 CP8

You can use the following get command to display the FortiGate-300D NP6 configuration. The command output
shows one NP6 named NP6_0 and the interfaces (ports) connected to it. You can also use the diagnose npu
np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0   0

  1 port5 1G Yes
  1 port7 1G Yes
  1 port8 1G Yes
  1 port6 1G Yes
  1 port3 1G Yes
  1 port4 1G Yes
  1 port1 1G Yes
  1 port2 1G Yes
  2
  3

------ ---- ------- ----- ----------

FortiGate-300E and 301E fast path architecture
The FortiGate-300E and 301E each include one NP6 processor. All front panel data interfaces (port1 to 28, S1,
S2, VW1, and VW2) connect to the NP6 processor. So all supported traffic passing between any two data
interfaces can be offloaded.

The following diagram also shows the XAUI and QSGMII port connections between the NP6 processor and the
front panel interfaces.
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CPUCP9

System Bus

port1-16

2x XAUI
port17-28 S1, S2, VW1, and VW2

4xQSGMII

NP6_0

You can use the following get command to display the FortiGate-300E or 301E NP6 configuration. You can also
use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port1 1G Yes

0 port2 1G Yes
0 port3 1G Yes
0 port4 1G Yes
0 port5 1G Yes
0 port6 1G Yes
0 port7 1G Yes
0 port8 1G Yes
1 port9 1G Yes
1 port10 1G Yes
1 port11 1G Yes
1 port12 1G Yes
1 port13 1G Yes
1 port14 1G Yes
1 port15 1G Yes
1 port16 1G Yes
2 port17 1G Yes
2 port18 1G Yes
2 port19 1G Yes
2 port20 1G Yes
2 port21 1G Yes
2 port22 1G Yes
2 port23 1G Yes
2 port2 1G Yes
3 port25 1G Yes
3 port26 1G Yes
3 port27 1G Yes
3 port28 1G Yes
3 s1 1G Yes
3 s2 1G Yes
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3 vw1 1G Yes
3 vw2 1G Yes

------ ---- ------- ----- ----------

FortiGate-400D fast path architecture
The FortiGate-400D includes one NP6 processor connected to eight 1Gb SFP interfaces (port1-port8) and eight
1Gb RJ-45 Ethernet ports (port9-16).

FortiASIC

NP6

CPUCP8 CP8

You can use the following get command to display the FortiGate-400D NP6 configuration. The command output
shows one NP6 named NP6_0 and the interfaces (ports) connected to it. You can also use the diagnose npu
np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0

  1 port10 1G Yes
  1 port9 1G Yes
  1 port12 1G Yes
  1 port11 1G Yes
  1 port14 1G Yes
  1 port13 1G Yes
  1 port16 1G Yes
  1 port15 1G Yes
  1 port5 1G Yes
  1 port7 1G Yes
  1 port8 1G Yes
  1 port6 1G Yes
  1 port3 1G Yes
  1 port4 1G Yes
  1 port1 1G Yes
  1 port2 1G Yes
  2
  3

------ ---- ------- ----- ----------

1627 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 14 - Hardware Acceleration FortiGate NP6 architectures

FortiGate-500D fast path architecture
The FortiGate-500D includes one NP6 processor connected to eight 1Gb SFP interfaces (port1-port8) and eight
1Gb RJ-45 Ethernet ports (port9-16).

FortiASIC

NP6

CPUCP8 CP8

You can use the following get command to display the FortiGate-500D NP6 configuration. The command output
shows one NP6 named NP6_0 and the interfaces (ports) connected to it. You can also use the diagnose npu
np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0

  1 port10 1G Yes
  1 port9 1G Yes
  1 port12 1G Yes
  1 port11 1G Yes
  1 port14 1G Yes
  1 port13 1G Yes
  1 port16 1G Yes
  1 port15 1G Yes
  1 port5 1G Yes
  1 port7 1G Yes
  1 port8 1G Yes
  1 port6 1G Yes
  1 port3 1G Yes
  1 port4 1G Yes
  1 port1 1G Yes
  1 port2 1G Yes
  2
  3

------ ---- ------- ----- ----------

FortiGate-500E and 501E fast path architecture
The FortiGate-500E and 501E each include one NP6 processor. All front panel data interfaces (port1 to 212, S1,
S2, VW1, VW2, X1 and X2) connect to the NP6 processor. So all supported traffic passing between any two data
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interfaces can be offloaded.

The following diagram also shows the QSGMII and XAUI port connections between the NP6 processor and the
front panel interfaces.

port1-8

2x QSGMII

port9-12, S1, S2, VW1, VW2

2x QSGMII

X1 and X2

2x XAUI

CPUCP9 CP9

System Bus

NP6_0

You can use the following get command to display the FortiGate-500E or 501E NP6 configuration. You can also
use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 x1 10G Yes

1 port1 1G Yes
1 port2 1G Yes
1 port3 1G Yes
1 port4 1G Yes
1 port5 1G Yes
1 port6 1G Yes
1 port7 1G Yes
1 port8 1G Yes
1 port9 1G Yes
1 port10 1G Yes
1 port11 1G Yes
1 port12 1G Yes
1 s1 1G Yes
1 s2 1G Yes
1 vw1 1G Yes
1 vw2 1G Yes
2 x2 10G Yes
3

------ ---- ------- ----- ----------

FortiGate-600D fast path architecture
The FortiGate-600D includes one NP6 processor connected to eight 1Gb SFP interfaces (port1-port8) and eight
1Gb RJ-45 Ethernet ports (port9-16) and two 10Gb SFP+ interfaces (port17 and port18).
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You can use the following get command to display the FortiGate-600D NP6 configuration. The command output
shows one NP6 named NP6_0 and the interfaces (ports) connected to it. You can also use the diagnose npu
np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

 Speed offloading
------ ---- ------- ----- ----------
np6_0 0

  1 port10 1G Yes
  1 port9 1G Yes
  1 port12 1G Yes
  1 port11 1G Yes
  1 port14 1G Yes
  1 port13 1G Yes
  1 port16 1G Yes
  1 port15 1G Yes
  1 port5 1G Yes
  1 port7 1G Yes
  1 port8 1G Yes
  1 port6 1G Yes
  1 port3 1G Yes
  1 port4 1G Yes
  1 port1 1G Yes
  1 port2 1G Yes
  2    port17  10G   Yes
  3    port18  10G   Yes

------ ---- ------- ----- ----------

FortiGate-800D fast path architecture
The FortiGate-800D includes one NP6 processor connected through an integrated switch fabric to all of the
FortiGate-800D network interfaces. This hardware configuration supports NP6-accelerated fast path offloading
for sessions between any of the FortiGate-800D interfaces.
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You can use the following get command to display the FortiGate-800D NP6 configuration. The command output
shows one NP6 named NP6_0. The output also shows all of the FortiGate-800D interfaces (ports) connected to
NP6_0. You can also use the diagnose npu np6 port-list command to display this information.
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get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port31 10G Yes

1 wan1 1G Yes
1 port1 1G Yes
1 wan2 1G Yes
1 port2 1G Yes
1 port3 1G Yes
1 port4 1G Yes
1 port5 1G Yes
1 port6 1G Yes
1 port30 1G Yes
1 port29 1G Yes
1 port28 1G Yes
1 port27 1G Yes
1 port26 1G Yes
1 port25 1G Yes
1 port24 1G Yes
1 port23 1G Yes
2 port7 1G Yes
2 port8 1G Yes
2 port9 1G Yes
2 port10 1G Yes
2 port11 1G Yes
2 port12 1G Yes
2 port13 1G Yes
2 port14 1G Yes
2 port15 1G Yes
2 port16 1G Yes
2 port17 1G Yes
2 port18 1G Yes
2 port19 1G Yes
2 port20 1G Yes
2 port21 1G Yes
2 port22 1G Yes
3 port32 10G Yes

------ ---- ------- ----- ----------

FortiGate-900D fast path architecture
The FortiGate-900D includes two NP6 processors that are not connected by an integrated switch fabric (ISF).
Without an ISF, traffic through a FortiGate-900D could experience lower latency than traffic through similar
hardware with an ISF. The NP6 processors are connected to network interfaces as follows:

Because the FortiGate-900D does not have an ISF you cannot create Link
Aggregation Groups (LAGs) that include interfaces connected to both NP6 processors.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1632



FortiGate NP6 architectures Chapter 14 - Hardware Acceleration

l Eight 1Gb SFP interfaces (port17-port24), eight 1Gb RJ-45 Ethernet interfaces (port25-32) and one 10Gb SFP+
interface (portB) share connections to the first NP6 processor.

l Eight 1Gb SFP interfaces (port1-port8), eight RJ-45 Ethernet interfaces (port9-16) and one 10Gb SFP+ interface
(portA) share connections to the second NP6 processor.
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You can use the following get command to display the FortiGate-900D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1. The output also shows the interfaces (ports) connected to each NP6.
You can also use the diagnose npu np6 port-list command to display this information.
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get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

 Speed offloading
------ ---- ------- ----- ----------
np6_0 0

  1 port17 1G Yes
  1 port18 1G Yes
  1 port19 1G Yes
  1 port20 1G Yes
  1 port21 1G Yes
  1 port22 1G Yes
  1 port23 1G Yes
  1 port24 1G Yes
  1 port27 1G Yes
  1 port28 1G Yes
  1 port25 1G Yes
  1 port26 1G Yes
  1 port31 1G Yes
  1 port32 1G Yes
  1 port29 1G Yes
  1 port30 1G Yes
  2 portB 10G Yes
  3

------ ---- ------- ----- ----------
np6_1 0

1 port1 1G Yes
1 port2 1G Yes
1    port3 1G Yes
1 port4  1G    Yes
1 port5 1G    Yes
1 port6 1G    Yes
1 port7 1G    Yes
1 port8  1G    Yes
1    port11 1G    Yes
1    port12 1G    Yes
1    port9  1G    Yes
1    port10 1G    Yes
1    port15 1G    Yes
1    port16 1G    Yes
1    port13 1G    Yes
1    port14 1G    Yes
2    portA  10G   Yes
3

FortiGate-1000D fast path architecture
The FortiGate-1000D includes two NP6 processors that are not connected by an integrated switch fabric (ISF).
The NP6 processors are connected to network interfaces as follows:

Because the FortiGate-1000D does not have an ISF you cannot create Link
Aggregation Groups (LAGs) or redundant interfaces that include interfaces connected
to both NP6 processors.
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l Eight 1Gb SFP interfaces (port17-port24), eight 1Gb RJ-45 Ethernet interfaces (port25-32) and one 10Gb SFP+
interface (portB) share connections to the first NP6 processor.

l Eight 1Gb SFP interfaces (port1-port8), eight RJ-45 Ethernet interfaces (port9-16) and one 10Gb SFP+ interface
(portA) share connections to the second NP6 processor.
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You can use the following get command to display the FortiGate-1000D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1. The output also shows the interfaces (ports) connected to each NP6.
You can also use the diagnose npu np6 port-list command to display this information.
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get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

 Speed offloading
------ ---- ------- ----- ----------
np6_0 0

  1 port17 1G Yes
  1 port18 1G Yes
  1 port19 1G Yes
  1 port20 1G Yes
  1 port21 1G Yes
  1 port22 1G Yes
  1 port23 1G Yes
  1 port24 1G Yes
  1 port27 1G Yes
  1 port28 1G Yes
  1 port25 1G Yes
  1 port26 1G Yes
  1 port31 1G Yes
  1 port32 1G Yes
  1 port29 1G Yes
  1 port30 1G Yes
  2 portB 10G Yes
  3

------ ---- ------- ----- ----------
np6_1 0

1 port1 1G Yes
1 port2 1G Yes
1    port3 1G Yes
1 port4  1G    Yes
1 port5 1G    Yes
1 port6 1G    Yes
1 port7 1G    Yes
1 port8  1G    Yes
1    port11 1G    Yes
1    port12 1G    Yes
1    port9  1G    Yes
1    port10 1G    Yes
1    port15 1G    Yes
1    port16 1G    Yes
1    port13 1G    Yes
1    port14 1G    Yes
2    portA  10G   Yes
3

FortiGate-1200D fast path architecture
The FortiGate-1200D features two NP6 processors both connected to an integrated switch fabric.

l Eight SFP 1Gb interfaces (port1-port8), eight RJ-45 Ethernet ports (port17-24) and two SFP+ 10Gb interfaces
(port33 and port34) share connections to the first NP6 processor.

l Eight SFP 1Gb interfaces (port9-port16), eight RJ-45 Ethernet ports (port25-32) and two SFP+ 10Gb interfaces
(port35-port36) share connections to the second NP6 processor.
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You can use the following get command to display the FortiGate-1200D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1. The output also shows the interfaces (ports) connected to each NP6.
You can also use the diagnose npu np6 port-list command to display this information.
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get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port33 10G Yes

1 port34 10G Yes
2 port1 1G Yes
2 port3 1G Yes
2 port5 1G Yes
2 port7 1G Yes
2 port17 1G Yes
2 port19 1G Yes
2 port21 1G Yes
2 port23 1G Yes
3 port2 1G Yes
3 port4 1G Yes
3 port6 1G Yes
3 port8 1G Yes
3 port18 1G Yes
3 port20 1G Yes
3 port22 1G Yes
3 port24 1G Yes

------ ---- ------- ----- ----------
np6_1 0 port35 10G Yes

1 port36 10G Yes
2 port9 1G Yes
2 port11 1G Yes
2 port13 1G Yes
2 port15 1G Yes
2 port25 1G Yes
2 port27 1G Yes
2 port29 1G Yes
2 port31 1G Yes
3 port10 1G Yes
3 port12 1G Yes
3 port14 1G Yes
3 port16 1G Yes
3 port26 1G Yes
3 port28 1G Yes
3 port30 1G Yes
3 port32 1G Yes

------ ---- ------- ----- ----------
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FortiGate-1500D fast path architecture
The FortiGate-1500D features two NP6 processors both connected to an integrated switch fabric.

l Eight SFP 1Gb interfaces (port1-port8), eight RJ-45 1Gb Ethernet interfaces (port17-24) and four SFP+ 10Gb
interfaces (port33-port36) share connections to the first NP6 processor.

l Eight SFP 1Gb interfaces (port9-port16), eight RJ-45 1Gb Ethernet interfaces (port25-32) and four SFP+ 10Gb
interfaces (port37-port40) share connections to the second NP6 processor.
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You can use the following get command to display the FortiGate-1500D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1. The output also shows the interfaces (ports) connected to each NP6.
You can also use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port1 1G Yes

0 port5 1G Yes
0 port17 1G Yes
0 port21 1G Yes
0 port33 10G Yes
1 port2 1G Yes
1 port6 1G Yes
1 port18 1G Yes
1 port22 1G Yes
1 port34 10G Yes
2 port3 1G Yes
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2 port7 1G Yes
2 port19 1G Yes
2 port23 1G Yes
2 port35 10G Yes
3 port4 1G Yes
3 port8 1G Yes
3 port20 1G Yes
3 port24 1G Yes
3 port36 10G Yes

------ ---- ------- ----- ----------
np6_1 0 port9 1G Yes

0 port13 1G Yes
0 port25 1G Yes
0 port29 1G Yes
0 port37 10G Yes
1 port10 1G Yes
1 port14 1G Yes
1 port26 1G Yes
1 port30 1G Yes
1 port38 10G Yes
2 port11 1G Yes
2 port15 1G Yes
2 port27 1G Yes
2 port31 1G Yes
2 port39 10G Yes
3 port12 1G Yes
3 port16 1G Yes
3 port28 1G Yes
3 port32 1G Yes
3 port40 10G Yes

------ ---- ------- ----- ----------

FortiGate-1500DT fast path architecture
The FortiGate-1500DT features two NP6 processors both connected to an integrated switch fabric. The
FortiGate-1500DT has the same hardware configuration as the FortiGate-1500D, but with the addition of newer
CPUs and a slightly different interface configuration.

The FortiGate-1500DT includes the following interfaces and NP6 processors:

l Eight SFP 1Gb interfaces (port1-port8), eight RJ-45 1Gb Ethernet interfaces (port17-24) and four RJ-45 10Gb
Ethernet interfaces (port33-port36) share connections to the first NP6 processor.

l Eight SFP 1Gb interfaces (port9-port16), eight RJ-45 1Gb Ethernet ports (port25-32) and four SFP+ 10Gb
interfaces (port37-port40) share connections to the second NP6 processor.
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You can use the following get command to display the FortiGate-1500DT NP6 configuration. The command
output shows two NP6s named NP6_0 and NP6_1. The output also shows the interfaces (ports) connected to
each NP6. You can also use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port1 1G Yes

0 port5 1G Yes
0 port17 1G Yes
0 port21 1G Yes
0 port33 10G Yes
1 port2 1G Yes
1 port6 1G Yes
1 port18 1G Yes
1 port22 1G Yes
1 port34 10G Yes
2 port3 1G Yes
2 port7 1G Yes
2 port19 1G Yes
2 port23 1G Yes
2 port35 10G Yes
3 port4 1G Yes
3 port8 1G Yes
3 port20 1G Yes
3 port24 1G Yes
3 port36 10G Yes
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------ ---- ------- ----- ----------
np6_1 0 port9 1G Yes

0 port13 1G Yes
0 port25 1G Yes
0 port29 1G Yes
0 port37 10G Yes
1 port10 1G Yes
1 port14 1G Yes
1 port26 1G Yes
1 port30 1G Yes
1 port38 10G Yes
2 port11 1G Yes
2 port15 1G Yes
2 port27 1G Yes
2 port31 1G Yes
2 port39 10G Yes
3 port12 1G Yes
3 port16 1G Yes
3 port28 1G Yes
3 port32 1G Yes
3 port40 10G Yes

------ ---- ------- ----- ----------

FortiGate-2000E fast path architecture
The FortiGate-2000E includes three NP6 processors in an NPDirect configuration. The NP6 processors
connected to the 10GigE ports are also in a low latency NPDirect configuration. Because of NP Direct, you
cannot create Link Aggregation Groups (LAGs) or redundant interfaces between interfaces connected to different
NP6s. As well, traffic will only be offloaded if it enters and exits the FortiGate on interfaces connected to the
same NP6.

The NP6s are connected to network interfaces as follows:

l NP6_0 is connected to four 10GigE SFP+ interfaces (port33 to port36) in a low latency configuration.
l NP6_1 is connected to thirty-two 10/100/1000BASE-T interfaces (port1 to port32).
l NP6_2 is connected to two 10GigE SFP+ (port37 and port38) in a low latency configuration.

The following diagram also shows the XAUI and QSGMII port connections between the NP6 processors and the
front panel interfaces and the aggregate switch for the thirty-two 10/100/1000BASE-T interfaces.
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You can use the following get command to display the FortiGate-2000E NP6 configuration. You can also use the
diagnose npu np6 port-list command to display this information.
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get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_1 0 port1 1G No

0 port5 1G No
0 port9 1G No
0 port13 1G No
0 port17 1G No
0 port21 1G No
0 port25 1G No
0 port29 1G No
1 port2 1G No
1 port6 1G No
1 port10 1G No
1 port14 1G No
1 port18 1G No
1 port22 1G No
1 port26 1G No
1 port30 1G No
2 port3 1G No
2 port7 1G No
2 port11 1G No
2 port15 1G No
2 port19 1G No
2 port23 1G No
2 port27 1G No
2 port31 1G No
3 port4 1G No
3 port8 1G No
3 port12 1G No
3 port16 1G No
3 port20 1G No
3 port24 1G No
3 port28 1G No
3 port32 1G No

------ ---- ------- ----- ----------
np6_0 0 port33 10G No

1 port34 10G No
2 port35 10G No
3 port36 10G No

------ ---- ------- ----- ----------
np6_2 0 port37 10G No

1 port38 10G No
------ ---- ------- ----- ----------

FortiGate-2500E fast path architecture
The FortiGate-2500E includes four NP6 processors in an NPDirect configuration. The NP6 processors connected
to the 10GigE ports are also in a low latency NPDirect configuration. Because of NP Direct, you cannot create
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Link Aggregation Groups (LAGs) or redundant interfaces between interfaces connected to different NP6s. As
well, traffic will only be offloaded if it enters and exits the FortiGate on interfaces connected to the same NP6.

The NP6s are connected to network interfaces as follows:

l NP6_0 is connected to four 10GigE SFP+ interfaces (port37 to port40) in a low latency configuration.
l NP6_1 is connected to thirty-two 10/100/1000BASE-T interfaces (port1 to port32).
l NP6_2 is connected to two 10GigE SFP+ interfaces (port41 and port42) and two 10 Gig fiber bypass interfaces

(port43 and port44) in a low latency configuration.
l NP6_3 is connected to four 10GigE SFP+ interfaces (port33 to port36) in a low latency configuration.

The following diagram also shows the XAUI and QSGMII port connections between the NP6 processors and the
front panel interfaces and the aggregate switch for the thirty-two 10/100/1000BASE-T interfaces.

STATUS

CONSOLE

USB

ALARM

HA

POWER

1

MGMT2

MGMT1

18

2321

2220 2624 30 3228

31 33 35 41

BP

42

37

38

43

443634

29272519

16

17

14

15

12

13

108

117 9

6

5

4

3

2

SFP+

39

40

CPUCP9 CP9

System Bus

port1- 32 (32 x 1G)

8 x QSGMII

4 x XAUI

port37 - 40

4 x XAUI

port41 - 44

4 x XAUI

NP6_1 NP6_2

port33 - 36

4 x XAUI

NP6_3

port4136

NP6_0
Aggregation Switch

You can use the following get command to display the FortiGate-2500E NP6 configuration. You can also use the
diagnose npu np6 port-list command to display this information.
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get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_1 0 port1 1G No

0 port5 1G No
0 port9 1G No
0 port13 1G No
0 port17 1G No
0 port21 1G No
0 port25 1G No
0 port29 1G No
1 port2 1G No
1 port6 1G No
1 port10 1G No
1 port14 1G No
1 port18 1G No
1 port22 1G No
1 port26 1G No
1 port30 1G No
2 port3 1G No
2 port7 1G No
2 port11 1G No
2 port15 1G No
2 port19 1G No
2 port23 1G No
2 port27 1G No
2 port31 1G No
3 port4 1G No
3 port8 1G No
3 port12 1G No
3 port16 1G No
3 port20 1G No
3 port24 1G No
3 port28 1G No
3 port32 1G No

------ ---- ------- ----- ----------
np6_0 0 port37 10G No

1 port38 10G No
2 port39 10G No
3 port40 10G No

------ ---- ------- ----- ----------
np6_2 0 port43 10G No

1 port44 10G No
2 port41 10G No
3 port42 10G No

------ ---- ------- ----- ----------
np6_3 0 port33 10G No

1 port34 10G No
2 port35 10G No
3 port36 10G No

------ ---- ------- ----- ----------
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FortiGate-3000D fast path architecture
The FortiGate-3000D features 16 front panel SFP+ 10Gb interfaces connected to two NP6 processors through an
Integrated Switch Fabirc (ISF). The FortiGate-3000D has the following fastpath architecture:

l 8 SFP+ 10Gb interfaces, port1 through port8 share connections to the first NP6 processor (np6_0).

l 8 SFP+ 10Gb interfaces, port9 through port16 share connections to the second NP6 processor (np6_1).
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You can use the following get command to display the FortiGate-3000D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1 and the interfaces (ports) connected to each NP6. You can also use
the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port1 10G Yes

0 port6 10G Yes
1 port2 10G Yes
1 port5 10G Yes
2 port3 10G Yes
2 port8 10G Yes
3 port4 10G Yes
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3 port7 10G Yes
------ ---- ------- ----- ----------
np6_1 0 port10 10G Yes

0 port13 10G Yes
1 port9 10G Yes
1 port14 10G Yes
2 port12 10G Yes
2 port15 10G Yes
3 port11 10G Yes
3 port16 10G Yes

------ ---- ------- ----- ----------

FortiGate-3100D fast path architecture
The FortiGate-3100D features 32 SFP+ 10Gb interfaces connected to two NP6 processors through an Integrated
Switch Fabirc (ISF). The FortiGate-3100D has the following fastpath architecture:

l 16 SFP+ 10Gb interfaces, port1 through port16 share connections to the first NP6 processor (np6_0).

l 16 SFP+ 10Gb interfaces, port27 through port32 share connections to the second NP6 processor (np6_1).
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You can use the following get command to display the FortiGate-3100D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1 and the interfaces (ports) connected to each NP6. You can also use
the diagnose npu np6 port-list command to display this information.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1648



FortiGate NP6 architectures Chapter 14 - Hardware Acceleration

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port1 10G Yes

0 port6 10G Yes
0 port10 10G Yes
0 port13 10G Yes
1 port2 10G Yes
1 port5 10G Yes
1 port9 10G Yes
1 port14 10G Yes
2 port3 10G Yes
2 port8 10G Yes
2 port12 10G Yes
2 port15 10G Yes
3 port4 10G Yes
3 port7 10G Yes
3 port11 10G Yes
3 port16 10G Yes

------ ---- ------- ----- ----------
np6_1 0 port17 10G Yes

0 port21 10G Yes
0 port25 10G Yes
0 port29 10G Yes
1 port18 10G Yes
1 port22 10G Yes
1 port26 10G Yes
1 port30 10G Yes
2 port19 10G Yes
2 port23 10G Yes
2 port27 10G Yes
2 port31 10G Yes
3 port20 10G Yes
3 port24 10G Yes
3 port28 10G Yes
3 port32 10G Yes

------ ---- ------- ----- ----------

FortiGate-3200D fast path architecture
The FortiGate-3200D features two NP6 processors connected to an Integrated Switch Fabirc (ISF). The
FortiGate-3200D has the following fastpath architecture:

l 24 SFP+ 10Gb interfaces, port1 through port24 share connections to the first NP6 processor (np6_0).

l 24 SFP+ 10Gb interfaces, port25 through port48 share connections to the second NP6 processor (np6_1).
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You can use the following get command to display the FortiGate-3200D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1 and the interfaces (ports) connected to each NP6. You can also use
the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port1 10G Yes

0 port5 10G Yes
0 port10 10G Yes
0 port13 10G Yes
0 port17 10G Yes
0 port22 10G Yes
1 port2 10G Yes
1 port6 10G Yes
1 port9 10G Yes
1 port14 10G Yes
1 port18 10G Yes
1 port21 10G Yes
2 port3 10G Yes
2 port7 10G Yes
2 port12 10G Yes
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2 port15 10G Yes
2 port19 10G Yes
2 port24 10G Yes
3 port4 10G Yes
3 port8 10G Yes
3 port11 10G Yes
3 port16 10G Yes
3 port20 10G Yes
3 port23 10G Yes

------ ---- ------- ----- ----------
np6_1 0 port26 10G Yes

0 port29 10G Yes
0 port33 10G Yes
0 port37 10G Yes
0 port41 10G Yes
0 port45 10G Yes
1 port25 10G Yes
1 port30 10G Yes
1 port34 10G Yes
1 port38 10G Yes
1 port42 10G Yes
1 port46 10G Yes
2 port28 10G Yes
2 port31 10G Yes
2 port35 10G Yes
2 port39 10G Yes
2 port43 10G Yes
2 port47 10G Yes
3 port27 10G Yes
3 port32 10G Yes
3 port36 10G Yes
3 port40 10G Yes
3 port44 10G Yes
3 port48 10G Yes

------ ---- ------- ----- ----------
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FortiGate-3700D fast path architecture
The FortiGate-3700D features four NP6 processors.The first two NP6 processors (np6_0 and np6_1) can be
configured for low latency operation. The low latency configuration changes the FortiGate-3700D fast path
architecture.

FortiGate-3700D low latency fast path architecture

Ports 25 to 32 can be used for low latency offloading. As long as traffic enters and exits the FortiGate-3700D
through ports connected to the same NP6 processor and using these low latency ports the traffic will be offloaded
and have lower latency that other NP6 offloaded traffic. Latency is reduced by bypassing the integrated switch
fabric (ISF).

You can use the following command to turn on low latency mode for np6_0 and np6_1:

config system np6
edit np6_0

set low-latency-mode enable
next
edit np6_1

set low-latency-mode enable
end

You do not have to turn on low latency to both np6_0 and np6_1. If you turn on low
latency for just one NP6, the other NP6 will still be mapped according to the normal
latency configuration.

With low latency enabled for both np6_0 and np6_1 the FortiGate-3700D has the following fastpath architecture:

l Four SFP+ 10Gb interfaces, port25 to port28, share connections to the first NP6 processor (np6_0) so sessions
entering one of these ports and exiting through another will experience low latency

l Four SFP+ 10Gb interfaces, port29 to port32, share connections to the second NP6 processor (np6_1) so sessions
entering one of these ports and exiting through another will experience low latency

l Ten SFP+ 10Gb interfaces, port5 to port14, and two 40Gb QSFP interfaces, port1 and port2, share connections to
the third NP6 processor (np6_2).

l Ten SFP+ 10Gb interfaces, port15 to port24, and two 40Gb QSFP interfaces, port3 and port4, share connections to
the fourth NP6 processor (np6_3).
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You can use the following get command to display the FortiGate-3700D NP6 configuration. In this output
example, the first two NP6s (np6_0 and np6_1) are configured for low latency. The command output shows four
NP6s named NP6_0, NP6_1, NP6_2, and NP6_3 and the interfaces (ports) connected to each NP6. You can also
use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_2 0 port5 10G Yes

0 port9 10G Yes
0 port13 10G Yes
1 port6 10G Yes
1 port10 10G Yes
1 port14 10G Yes
2 port7 10G Yes
2 port11 10G Yes
3 port8 10G Yes
3 port12 10G Yes
0-3 port1 40G Yes
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0-3 port2 40G Yes
------ ---- ------- ----- ----------
np6_3 0 port15 10G Yes

0 port19 10G Yes
0 port23 10G Yes
1 port16 10G Yes
1 port20 10G Yes
1 port24 10G Yes
2 port17 10G Yes
2 port21 10G Yes
3 port18 10G Yes
3 port22 10G Yes
0-3 port3 40G Yes
0-3 port4 40G Yes

------ ---- ------- ----- ----------
np6_0 0 port26 10G No

1 port25 10G No
2 port28 10G No
3 port27 10G No

------ ---- ------- ----- ----------
np6_1 0 port30 10G No

1 port29 10G No
2 port32 10G No
3 port31 10G No

------ ---- ------- ----- ----------

FortiGate-3700D normal latency fast path architecture

You can use the following command to turn off low latency mode for np6_0 and np6_1:

config system np6
edit np6_0

set low-latency-mode disable
next
edit np6_1

set low-latency-mode disable
end

You do not have to turn off low latency to both np6_0 and np6_1. If you turn off low
latency to just one NP6, the other NP6 will still be mapped according to the normal
configuration.

In addition to turning off low latency, entering these commands also changes how ports are mapped to NP6s.
Port1 is now mapped to np6_0 and port 3 is not mapped to np6_1. The FortiGate-3700D has the following
fastpath architecture:

l One 40Gb QSFP interface, port1, and four SFP+ 10Gb interfaces, port25 to port28 share connections to the first
NP6 processor (np6_0).

l One 40Gb QSFP interface, port3, and four SFP+ 10Gb interfaces, port29 to port32 share connections to the second
NP6 processor (np6_1).

l One 40Gb QSFP interface, port2 and ten SFP+ 10Gb interfaces, port5 to port14 share connections to the third NP6
processor (np6_2).
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l One 40Gb QSFP interface, port4, and ten SFP+ 10Gb interfaces, port15 to port24 share connections to the fourth
NP6 processor (np6_3).
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You can use the following get command to display the FortiGate-3700D NP6 configuration with low latency
turned off for np6_0 and np6_1. The command output shows four NP6s named NP6_0, NP6_1, NP6_2, and
NP6_3 and the interfaces (ports) connected to each NP6. You can also use the diagnose npu np6 port-
list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port26 10G Yes

1 port25 10G Yes
2 port28 10G Yes
3 port27 10G Yes
0-3 port1 40G Yes

------ ---- ------- ----- ----------
np6_1 0 port30 10G Yes

1 port29 10G Yes
2 port32 10G Yes
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3 port31 10G Yes
0-3 port3 40G Yes

------ ---- ------- ----- ----------
np6_2 0 port5 10G Yes

0 port9 10G Yes
0 port13 10G Yes
1 port6 10G Yes
1 port10 10G Yes
1 port14 10G Yes
2 port7 10G Yes
2 port11 10G Yes
3 port8 10G Yes
3 port12 10G Yes
0-3 port2 40G Yes

------ ---- ------- ----- ----------
np6_3 0 port15 10G Yes

0 port19 10G Yes
0 port23 10G Yes
1 port16 10G Yes
1 port20 10G Yes
1 port24 10G Yes
2 port17 10G Yes
2 port21 10G Yes
3 port18 10G Yes
3 port22 10G Yes
0-3 port4 40G Yes

------ ---- ------- ----- ----------

FortiGate-3700DX fast path architecture
The FortiGate-3700DX features four NP6 processors.The first two NP6 processors (np6_0 and np6_1) can be
configured for low latency operation. The low latency configuration changes the FortiGate-3700D fast path
architecture. The FortiGate-3700DX also includes two TP2 cards that offload GTPu sessions.

FortiGate-3700DX low latency fast path architecture

Ports 25 to 32 can be used for low latency offloading. As long as traffic enters and exits the FortiGate-3700D
through ports connected to the same NP6 processor and using these low latency ports the traffic will be offloaded
and have lower latency that other NP6 offloaded traffic. Latency is reduced by bypassing the integrated switch
fabric (ISF).

You can use the following command to turn on low latency mode for np6_0 and np6_1:

config system np6
edit np6_0

set low-latency-mode enable
next
edit np6_1

set low-latency-mode enable
end
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You do not have to turn on low latency to both np6_0 and np6_1. If you turn on low
latency for just one NP6, the other NP6 will still be mapped according to the normal
latency configuration.

With low latency enabled for both np6_0 and np6_1 the FortiGate-3700D has the following fastpath architecture:

l Four SFP+ 10Gb interfaces, port25 to port28, share connections to the first NP6 processor (np6_0) so sessions
entering one of these ports and exiting through another will experience low latency

l Four SFP+ 10Gb interfaces, port29 to port32, share connections to the second NP6 processor (np6_1) so sessions
entering one of these ports and exiting through another will experience low latency

l Ten SFP+ 10Gb interfaces, port5 to port14, and two 40Gb QSFP interfaces, port1 and port2, share connections to
the third NP6 processor (np6_2).

l Ten SFP+ 10Gb interfaces, port15 to port24, and two 40Gb QSFP interfaces, port3 and port4, share connections to
the fourth NP6 processor (np6_3).
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You can use the following get command to display the FortiGate-3700D NP6 configuration. In this output
example, the first two NP6s (np6_0 and np6_1) are configured for low latency. The command output shows four
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NP6s named NP6_0, NP6_1, NP6_2, and NP6_3 and the interfaces (ports) connected to each NP6. You can also
use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_2 0 port5 10G Yes

0 port9 10G Yes
0 port13 10G Yes
1 port6 10G Yes
1 port10 10G Yes
1 port14 10G Yes
2 port7 10G Yes
2 port11 10G Yes
3 port8 10G Yes
3 port12 10G Yes
0-3 port1 40G Yes
0-3 port2 40G Yes

------ ---- ------- ----- ----------
np6_3 0 port15 10G Yes

0 port19 10G Yes
0 port23 10G Yes
1 port16 10G Yes
1 port20 10G Yes
1 port24 10G Yes
2 port17 10G Yes
2 port21 10G Yes
3 port18 10G Yes
3 port22 10G Yes
0-3 port3 40G Yes
0-3 port4 40G Yes

------ ---- ------- ----- ----------
np6_0 0 port26 10G No

1 port25 10G No
2 port28 10G No
3 port27 10G No

------ ---- ------- ----- ----------
np6_1 0 port30 10G No

1 port29 10G No
2 port32 10G No
3 port31 10G No

------ ---- ------- ----- ----------

FortiGate-3700D normal latency fast path architecture

You can use the following command to turn off low latency mode for np6_0 and np6_1:

config system np6
edit np6_0

set low-latency-mode disable
next
edit np6_1

set low-latency-mode disable
end
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You do not have to turn off low latency to both np6_0 and np6_1. If you turn off low
latency to just one NP6, the other NP6 will still be mapped according to the normal
configuration.

In addition to turning off low latency, entering these commands also changes how ports are mapped to NP6s.
Port1 is now mapped to np6_0 and port 3 is not mapped to np6_1. The FortiGate-3700D has the following
fastpath architecture:

l One 40Gb QSFP interface, port1, and four SFP+ 10Gb interfaces, port25 to port28 share connections to the first
NP6 processor (np6_0).

l One 40Gb QSFP interface, port3, and four SFP+ 10Gb interfaces, port29 to port32 share connections to the second
NP6 processor (np6_1).

l One 40Gb QSFP interface, port2 and ten SFP+ 10Gb interfaces, port5 to port14 share connections to the third NP6
processor (np6_2).

l One 40Gb QSFP interface, port4, and ten SFP+ 10Gb interfaces, port15 to port24 share connections to the fourth
NP6 processor (np6_3).
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You can use the following get command to display the FortiGate-3700D NP6 configuration with low latency
turned off for np6_0 and np6_1. The command output shows four NP6s named NP6_0, NP6_1, NP6_2, and
NP6_3 and the interfaces (ports) connected to each NP6. You can also use the diagnose npu np6 port-
list command to display this information.
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get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port26 10G Yes

1 port25 10G Yes
2 port28 10G Yes
3 port27 10G Yes
0-3 port1 40G Yes

------ ---- ------- ----- ----------
np6_1 0 port30 10G Yes

1 port29 10G Yes
2 port32 10G Yes
3 port31 10G Yes
0-3 port3 40G Yes

------ ---- ------- ----- ----------
np6_2 0 port5 10G Yes

0 port9 10G Yes
0 port13 10G Yes
1 port6 10G Yes
1 port10 10G Yes
1 port14 10G Yes
2 port7 10G Yes
2 port11 10G Yes
3 port8 10G Yes
3 port12 10G Yes
0-3 port2 40G Yes

------ ---- ------- ----- ----------
np6_3 0 port15 10G Yes

0 port19 10G Yes
0 port23 10G Yes
1 port16 10G Yes
1 port20 10G Yes
1 port24 10G Yes
2 port17 10G Yes
2 port21 10G Yes
3 port18 10G Yes
3 port22 10G Yes
0-3 port4 40G Yes

------ ---- ------- ----- ----------

FortiGate-3800D fast path architecture
The FortiGate-3800D features four front panel 100GigE CFP2 interfaces, four 40GigEQSFP+ interfaces, and
eight 10GigE SFP+ interfaces connected to eight NP6 processors through an Integrated Switch Fabric (ISF).
Individual interfaces are not mapped to NP6 processors because of the integrated switch fabric. No special
mapping is required for fastpath offloading or aggregate interfaces.
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You can use the following get command to display the FortiGate-3800D NP6 configuration. The command output
shows all NP6s connected to each interface (port) with cross-chip offloading supported for each port. You can also
use the diagnose npu np6 port-list command to display this information.

Chip XAUI Ports Max Cross-chip
Speed offloading

------ ---- ------- ------ ----------
NP#0-7 0-3 port1 100000M Yes
NP#0-7 0-3 port2 100000M Yes
NP#0-7 0-3 port3 100000M Yes
NP#0-7 0-3 port4 100000M Yes
NP#0-7 0-3 port5 40000M Yes
NP#0-7 0-3 port6 40000M Yes
NP#0-7 0-3 port7 40000M Yes
NP#0-7 0-3 port8 40000M Yes
NP#0-7 0-3 port9 10000M Yes
NP#0-7 0-3 port10 10000M Yes
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NP#0-7 0-3 port11 10000M Yes
NP#0-7 0-3 port12 10000M Yes
NP#0-7 0-3 port13 10000M Yes
NP#0-7 0-3 port14 10000M Yes
NP#0-7 0-3 port15 10000M Yes
NP#0-7 0-3 port16 10000M Yes
------ ---- ------- ------ ----------

FortiGate-3810D fast path architecture
The FortiGate-3810D features six front panel 100GigE CFP2 interfaces connected to eight NP6 processors
through an Integrated Switch Fabric (ISF). Individual interfaces are not mapped to NP6 processors because of
the integrated switch fabric. No special mapping is required for fastpath offloading or aggregate interfaces.
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You can use the following get command to display the FortiGate-3810D NP6 configuration. The command output
shows all NP6s connected to each interface (port) with cross-chip offloading supported for each port. You can also
use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ------ ----------
all 0-3 port1 100000M Yes
all 0-3 port2 100000M Yes
all 0-3 port3 100000M Yes
all 0-3 port4 100000M Yes
all 0-3 port5 100000M Yes
all 0-3 port6 100000M Yes
------ ---- ------- ------ ----------

FortiGate-3815D fast path architecture
The FortiGate-3815D features four front panel 100GigE CFP2 interfaces and eight 10GigE SFP+ interfaces
connected to eight NP6 processors through an Integrated Switch Fabric (ISF). Individual interfaces are not
mapped to NP6 processors because of the integrated switch fabric. No special mapping is required for fastpath
offloading or aggregate interfaces.
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You can use the following get command to display the FortiGate-3815D NP6 configuration. The command output
shows all NP6s connected to each interface (port) with cross-chip offloading supported for each port. You can also
use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ------ ----------
all 0-3 port1 100000M Yes
all 0-3 port2 100000M Yes
all 0-3 port3 100000M Yes
all 0-3 port4 100000M Yes
all 0-3 port11 10000M Yes
all 0-3 port12 10000M Yes
all 0-3 port13 10000M Yes
all 0-3 port14 10000M Yes
all 0-3 port10 10000M Yes
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all 0-3 port9 10000M Yes
all 0-3 port8 10000M Yes
all 0-3 port7 10000M Yes
all 0-3 port5 10000M Yes
all 0-3 port6 10000M Yes

FortiGate-3960E fast path architecture
The FortiGate-3960E features sixteen front panel 10GigE SFP+ interfaces and six 100GigEQSFP+ interfaces
connected to sixteen NP6 processors through an Integrated Switch Fabric (ISF). Individual interfaces are not
mapped to NP6 processors because of the integrated switch fabric. No special mapping is required for fastpath
offloading or aggregate interfaces.
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You can use the following get command to display the FortiGate-3960E NP6 configuration. The command output
shows all NP6s connected to each interface (port) with cross-chip offloading supported for each port. You can also
use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ------ ----------
NP#0-7 0-3 port1 10000M Yes
NP#2 0-3 port2 10000M Yes
NP#0-7 0-3 port3 10000M Yes
NP#0-7 0-3 port4 10000M Yes
NP#0-7 0-3 port5 10000M Yes
NP#0-7 0-3 port6 10000M Yes
NP#0-7 0-3 port7 10000M Yes
NP#0-7 0-3 port8 10000M Yes
NP#0-7 0-3 port9 10000M Yes
NP#0-7 0-3 port10 10000M Yes
NP#0-7 0-3 port11 10000M Yes
NP#0-7 0-3 port12 10000M Yes
NP#0-7 0-3 port13 10000M Yes
NP#0-7 0-3 port14 10000M Yes
NP#0-7 0-3 port15 10000M Yes
NP#0-7 0-3 port16 10000M Yes
NP#7 0-3 port17 100000M Yes
NP#0-7 0-3 port18 100000M Yes
NP#10 0-3 port19 100000M Yes
NP#12-15 0-3 port20 100000M Yes
NP#8-15 0-3 port21 100000M Yes
NP#8-15 0-3 port22 100000M Yes
------ ---- ------- ------ ----------

FortiGate-3980E fast path architecture
The FortiGate-3980E features sixteen front panel 10GigE SFP+ interfaces and ten 100GigEQSFP28 interfaces
connected to twenty-eight NP6 processors through an Integrated Switch Fabric (ISF). Individual interfaces are not
mapped to NP6 processors because of the integrated switch fabric. No special mapping is required for fastpath
offloading or aggregate interfaces.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1666



FortiGate NP6 architectures Chapter 14 - Hardware Acceleration

CP9CP9
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CPU

CP9CP9

CP9

System Bus
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You can use the following get command to display the FortiGate-3980E NP6 configuration. The command output
shows all NP6s connected to each interface (port) with cross-chip offloading supported for each port. You can also
use the diagnose npu np6 port-list command to display this information.

diagnose npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ------ ----------
NP#0-7 0-3 port1 10000M Yes
NP#0-7 0-3 port2 10000M Yes
NP#0-7 0-3 port3 10000M Yes
NP#0-7 0-3 port4 10000M Yes
NP#0-7 0-3 port5 10000M Yes
NP#0-7 0-3 port6 10000M Yes
NP#0-7 0-3 port7 10000M Yes
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NP#0-7 0-3 port8 10000M Yes
NP#0-7 0-3 port9 10000M Yes
NP#0-7 0-3 port10 10000M Yes
NP#0-7 0-3 port11 10000M Yes
NP#0-7 0-3 port12 10000M Yes
NP#0-7 0-3 port13 10000M Yes
NP#0-7 0-3 port14 10000M Yes
NP#0-7 0-3 port15 10000M Yes
NP#0-7 0-3 port16 10000M Yes
NP#0-7 0-3 port17 100000M Yes
NP#0-7 0-3 port18 100000M Yes
NP#8-27 0-3 port19 100000M Yes
NP#8-27 0-3 port20 100000M Yes
NP#8-27 0-3 port21 100000M Yes
NP#8-27 0-3 port22 100000M Yes
NP#8-27 0-3 port23 100000M Yes
NP#8-27 0-3 port24 100000M Yes
NP#8-27 0-3 port25 100000M Yes
NP#8-27 0-3 port26 100000M Yes

FortiGate-5001D fast path architecture
The FortiGate5001D features two NP6 processors.

l port1, port3, fabric1 and base1 share connections to the first NP6 processor.
l port2, port4, fabric2 and base2 share connections to the second NP6 processor.
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System Bus
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NP6 default interface mapping

You can use the following get command to display the FortiGate-5001D NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1. The output also shows the interfaces (ports) connected to each NP6.
You can also use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------

np6_0 0 port3 10G Yes
1
2 base1 1G Yes
3
0-3 port1 40G Yes
0-3 fabric1 40G Yes
0-3 fabric3 40G Yes
0-3 fabric5 40G Yes

------ ---- ------- ----- ----------
np6_1 0

1 port4 10G Yes
2
3 base2 1G Yes
0-3 port2 40G Yes
0-3 fabric2 40G Yes
0-3 fabric4 40G Yes

------ ---- ------- ----- ----------

NP6 interface mapping with split ports

If you use the following CLI command to split port1:

config system global
set split-port port1

end

The new split ports (port1/1 to port 1/4) are mapped to the same NP6 as the un-split port1 interface:

diagnose npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port3 10G Yes

0 port1/1 10G Yes
1 port1/2 10G Yes
2 base1 1G Yes
2 port1/3 10G Yes
3 port1/4 10G Yes
0-3 fabric1 40G Yes
0-3 fabric3 40G Yes
0-3 fabric5 40G Yes

------ ---- ------- ----- ----------
np6_1 0

1 port4 10G Yes
2
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3 base2 1G Yes
0-3 port2 40G Yes
0-3 fabric2 40G Yes
0-3 fabric4 40G Yes

------ ---- ------- ----- ----------

FortiGate-5001E and 5001E1 fast path architecture
The FortiGate-5001E and 5001E1 features two NP6 processors and an integrated switch fabric. The integrated
switch fabric allows you to configure aggregate interfaces between interfaces connected to different NP6s and
supports offloading between for traffic entering and exiting from any interfaces.

The NP6s are connected to network interfaces as follows:

l NP6_0 is connected to port1, port3, fabric1, and base1.
l NP6_1 is connected to port2, port4, fabric2, and base2.

The following diagram also shows the XAUI port connections between the NP6 processors and the front panel
interfaces and the integrated switch fabric.

NP6_1NP6 _0

Integrated Switch Fabric

CPU

CP9

CP9 CP9

CP9

System Bus

fabric1

5x XAUI

4x XAUI 4x XAUI

fabric2

5x XAUI

port1

XLAUI
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XLAUI
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XLAUI
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XFI

base1

SGMII
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SGMII

NP6 default interface mapping

You can use the following get command to display the FortiGate-5001E NP6 configuration. The command output
shows two NP6s named NP6_0 and NP6_1. The output also shows the interfaces (ports) connected to each NP6.
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You can also use the diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------

np6_0 0 port3 10G Yes
1
2 base1 1G Yes
3
0-3 port1 40G Yes
0-3 fabric1 40G Yes
0-3 fabric3 40G Yes
0-3 fabric5 40G Yes

------ ---- ------- ----- ----------
np6_1 0

1 port4 10G Yes
2
3 base2 1G Yes
0-3 port2 40G Yes
0-3 fabric2 40G Yes
0-3 fabric4 40G Yes

------ ---- ------- ----- ----------

NP6 interface mapping with split ports

If you use the following CLI command to split port1:

config system global
set split-port port1

end

The new split ports (port1/1 to port 1/4) are mapped to the same NP6 as the un-split port1 interface:

diagnose npu np6 port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6_0 0 port3 10G Yes

0 port1/1 10G Yes
1 port1/2 10G Yes
2 base1 1G Yes
2 port1/3 10G Yes
3 port1/4 10G Yes
0-3 fabric1 40G Yes
0-3 fabric3 40G Yes
0-3 fabric5 40G Yes

------ ---- ------- ----- ----------
np6_1 0

1 port4 10G Yes
2
3 base2 1G Yes
0-3 port2 40G Yes
0-3 fabric2 40G Yes
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0-3 fabric4 40G Yes
------ ---- ------- ----- ----------

FortiController-5902D fast path architecture
The FortiController-5902D NP6 network processors and integrated switch fabric (ISF) provide hardware
acceleration by offloading load balancing from the primary FortiController-5902D CPU. Network processors are
especially useful for accelerating load balancing of TCP and UDP sessions.

The first packet of every new session is received by the primary FortiController-5902D and the primary
FortiController-5902D uses its load balancing schedule to select the worker that will process the new session.
This information is passed back to an NP6 network processor and all subsequent packets of the same sessions
are offloaded to an NP6 network processor which sends the packet directly to a subordinate unit. Load balancing
is effectively offloaded from the primary unit to the NP6 network processors resulting in a faster and more stable
active-active cluster.

Traffic accepted by the FortiController-5902D F1 to F4 interfaces is that is processed by the primary
FortiController-5902D is also be offloaded to the NP6 processors.

Individual FortiController-5902D interfaces are not mapped to NP6 processors. Instead an Aggregator connects
the all fabric interfaces to the ISF and no special mapping is required for fastpath offloading.

Fabric Backplane

F1/2 to  F13

CPU

System Bus

Integrated Switch Fabric

FortiASIC

NP6

FortiASIC

NP6

I t t d S it h F b i

Aggregator

NP6 content clustering mode interface mapping

FortiController-5902Ds run in content clustering mode and load balance sessions to FortiGate-5001D workers.
Use the following command to enable content clustering:
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config system elbc
set mode content-cluster
set inter-chassis-support enable

end

You can use the following get command to display the content clustering FortiController-5902D NP6
configuration. The output shows that all ports are mapped to all NP6 processors. You can also use the
diagnose npu np6 port-list command to display this information.

get hardware npu np6 port-list

Chip XAUI Ports Max Cross-chip
Speed offloading

------ ---- ---------- ------ ----------
all 0-3 f1 40000M Yes
all 0-3 f2 40000M Yes
all 0-3 f3 40000M Yes
all 0-3 f4 40000M Yes
all 0-3 np6_0_4 10000M Yes
all 0-3 np6_0_5 10000M Yes
all 0-3 elbc-ctrl/1-2 40000M Yes
all 0-3 elbc-ctrl/3 40000M Yes
all 0-3 elbc-ctrl/4 40000M Yes
all 0-3 elbc-ctrl/5 40000M Yes
all 0-3 elbc-ctrl/6 40000M Yes
all 0-3 elbc-ctrl/7 40000M Yes
all 0-3 elbc-ctrl/8 40000M Yes
all 0-3 elbc-ctrl/9 40000M Yes
all 0-3 elbc-ctrl/10 40000M Yes
all 0-3 elbc-ctrl/11 40000M Yes
all 0-3 elbc-ctrl/12 40000M Yes
all 0-3 elbc-ctrl/13 40000M Yes
all 0-3 elbc-ctrl/14 40000M Yes
------ ---- ---------- ------ ----------

NP6 default interface mapping

You can use the following command to display the default FortiController-5902D NP6 configuration.

diagnose npu np6 port-list

Chip XAUI Ports Max Cross-chip
Speed offloading

------ ---- ---------- ------ ----------
all 0-3 f1 40000M Yes
all 0-3 f2 40000M Yes
all 0-3 f3 40000M Yes
all 0-3 f4 40000M Yes
all 0-3 np6_0_4 10000M Yes
all 0-3 np6_0_5 10000M Yes
all 0-3 fabric1/2 40000M Yes
all 0-3 fabric3 40000M Yes
all 0-3 fabric4 40000M Yes
all 0-3 fabric5 40000M Yes
all 0-3 fabric6 40000M Yes
all 0-3 fabric7 40000M Yes
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all 0-3 fabric8 40000M Yes
all 0-3 fabric9 40000M Yes
all 0-3 fabric10 40000M Yes
all 0-3 fabric11 40000M Yes
all 0-3 fabric12 40000M Yes
all 0-3 fabric13 40000M Yes
all 0-3 fabric14 40000M Yes

FortiGate-6000 series
The FortiGate-6000 series includes the FortiGate-6300F, 6301F, 6500F, and 6501F. All of these models have
the same hardware architecture. FortiGate-6000 models have separate data and management planes. The data
plane handles all traffic and security processing functionality. The management plane handles management
functions such as administrator logins, configuration and session synchronization, SNMP and other monitoring,
HA heartbeat communication, and remote and (if supported) local disk logging. Separating these two planes
means that resources used for traffic and security processing are not compromised by management activities.

FortiGate-6000 schematic
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In the data plane, two DP3 load balancers use session-aware load balancing to distribute sessions from the front
panel interfaces (port1 to 28) to Fortinet Processor Cards (FPCs). The DP3 processors communicate with the
FPCs across the 3.2Tbps integrated switch fabric. Each FPC processes sessions load balanced to it. The FPCs
send outgoing sessions back to the integrated switch fabric and then out the network interfaces to their
destinations.

The NP6 processor in each FPC enhances network performance with fastpath acceleration that offloads
communication sessions from the FPC CPU. The NP6 processor can also handle some CPU intensive tasks, like
IPsec VPN encryption/decryption. The NP6 processor in each FPC connects to the integrated switch fabric over
four XAUI ports.

The CP9 processors in each FPC accelerate many common resource intensive security related processes such as
SSL VPN, Antivirus, Application Control, and IPS.

The management plane includes the management board, base backplane, management interfaces, and HA
heartbeat interfaces. Configuration and session synchronization between FPCs in a FortiGate-6000F occurs over
the base backplane. In an HA configuration, configuration and session synchronization between the FortiGate-
6000s in the cluster takes place over the HA1 and HA2 interfaces. Administrator logins, SNMPmonitoring,
remote logging to one or more FortiAnalyzers or syslog servers, and other management functions use the
MGMT1, MGMT2, and MGMT3 interfaces. You can use the 10Gbps MGMT3 interface for additional bandwidth
that might be useful for high bandwidth activities such as remote logging.

From the management board, you can use the diagnose npu np6 port-list command to display the
FortiGate-6000 NP6 configuration. The command output shows the NP6 configuration for all of the FPCs. You
can see the same information for individual FPCs by logging into each FPC (for example by using the execute
system console-server connect <slot-number> command) and using the same diagnose
command or the get hardware npu np6 port-list command.

As shown in the example below for the FPC in slot 1, all of the FortiGate-6000 front panel interfaces and the
fabric backplane (elbc-ctrl) connect to the NP6 processor in each FPC.

diagnose npu np6 port-list
==========================================================================
Slot: 1 Module SN: FPC6KFT018900347
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ------ ----------
all 0-3 elbc-ctrl/110G Yes
all 0-3 port1 25G Yes
all 0-3 port2 25G Yes
all 0-3 port3 25G Yes
all 0-3 port4 25G Yes
all 0-3 port5 25G Yes
all 0-3 port6 25G Yes
all 0-3 port7 25G Yes
all 0-3 port8 25G Yes
all 0-3 port9 25G Yes
all 0-3 port10 25G Yes
all 0-3 port11 25G Yes
all 0-3 port12 25G Yes
all 0-3 port13 25G Yes
all 0-3 port14 25G Yes
all 0-3 port15 25G Yes
all 0-3 port16 25G Yes
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all 0-3 port17 25G Yes
all 0-3 port18 25G Yes
all 0-3 port19 25G Yes
all 0-3 port20 25G Yes
all 0-3 port21 25G Yes
all 0-3 port22 25G Yes
all 0-3 port23 25G Yes
all 0-3 port24 25G Yes
all 0-3 port25 100G Yes
all 0-3 port26 100G Yes
all 0-3 port27 100G Yes
all 0-3 port28 100G Yes
------ ---- ------- ------ ----------

FortiGate-7030E fast path architecture
The FortiGate-7030E chassis schematic below shows the communication channels between chassis components
including the management module (MGMT), the FIM (called FIM1) and the FPMs (FPM3 and FPM4).

The management module (MGMT, with Intelligent Platform Management Bus (IPMB) address 0x20)
communicates with all modules in the chassis over the base backplane. Each module, including the management
module includes a Shelf Management Controller (SMC). These SMCs support IPMB communication between the
management module and the FIM and FPMs for storing and sharing sensor data that the management module
uses to control chassis cooling and power distribution. The base backplane also supports serial communications
to allow console access from the management module to all modules, and 1Gbps Ethernet communication for
management and heartbeat communication between modules.

FIM1 (IPMB address 0x82) is the FIM in slot 1. The interfaces of this module connect the chassis to data
networks and can be used for Ethernet management access to chassis components. The FIM includes DP2
processors that distribute sessions over the Integrated Switch Fabric (ISF) to the NP6 processors in the FPMs.
Data sessions are communicated to the FPMs over the 80Gbps chassis fabric backplane.
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FPM3 and FPM4 (IPMB addresses 0x86 and 0x88) are the FPM processor modules in slots 3 and 4. These
worker modules process sessions distributed to them by the FIM. FPMs include NP6 processors to offload
sessions from the FPM CPU and CP9 processors that accelerate content processing.

FortiGate-7040E fast path architecture
The FortiGate-7040E chassis schematic below shows the communication channels between chassis components
including the management module (MGMT), the FIMs (called FIM1 and FIM2) and the FPMs (FPM3 and FPM4).

The management module (MGMT, with Intelligent Platform Management Bus (IPMB) address 0x20)
communicates with all modules in the chassis over the base backplane. Each module, including the management
module, includes a Shelf Management Controller (SMC). These SMCs support IPMB communication between
the management module and the FIM and FPMs for storing and sharing sensor data that the management
module uses to control chassis cooling and power distribution. The base backplane also supports serial
communications to allow console access from the management module to all modules, and 1Gbps Ethernet
communication for management and heartbeat communication between modules.

FIM1 and FIM2 (IPMB addresses 0x82 and 0x84) are the FIMs in slots 1 and 2. The interfaces of these modules
connect the chassis to data networks and can be used for Ethernet management access to chassis components.
The FIMs include DP2 processors that distribute sessions over the Integrated Switch Fabric (ISF) to the NP6
processors in the FPMs. Data sessions are communicated to the FPMs over the 80Gbps chassis fabric
backplane.

FPM3 and FPM4 (IPMB addresses 0x86 and 0x88) are the FPM processor modules in slots 3 and 4. These
worker modules process sessions distributed to them by the FIMs. FPMs include NP6 processors to offload
sessions from the FPM CPU and CP9 processors that accelerate content processing.

FortiGate-7060E fast path architecture
The FortiGate-7060E chassis schematic below shows the communication channels between chassis components
including the management modules (MGMT), the FIMs (called FIM1 and FIM2) and the FPMs (FPM3, FPM4,
FPM5, and FPM6).
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By default, MGMT2 is the active management module and MGMT1 is inactive. The active management module
always has the Intelligent Platform Management Bus (IPMB) address 0x20 and the inactive management module
always has the IPMB address 0x22.

The active management module communicates with all modules in the chassis over the base backplane. Each
module, including the management modules has a Shelf Management Controller (SMC). These SMCs support
IPMB communication between the active management module and the FIM and FPMs for storing and sharing
sensor data that the management module uses to control chassis cooling and power distribution. The base
backplane also supports serial communications to allow console access from the management module to all
modules, and 1Gbps Ethernet communication for management and heartbeat communication between modules.

FIM1 and FIM2 (IPMB addresses 0x82 and 0x84) are the FIMs in slots 1 and 2. The interfaces of these modules
connect the chassis to data networks and can be used for Ethernet management access to chassis components.
The FIMs include DP2 processors that distribute sessions over the Integrated Switch Fabric (ISF) to the NP6
processors in the FPMs. Data sessions are communicated to the FPMs over the 80Gbps chassis fabric
backplane.

FPM03, FPM04, FPM05, and FPM06 (IPMB addresses 0x86, 0x88, 0x8A, and 0x8C) are the FPM processor
modules in slots 3 to 6. These worker modules process sessions distributed to them by the FIMs. FPMs include
NP6 processors to offload sessions from the FPM CPU and CP9 processors that accelerate content processing.

FPM-7620E fast path architecture
In a FortiGate-7000 chassis, FPM-7620E NP6 network processors combined with the FortiGate Interface Module
(FIM) Integrated Switch Fabric (ISF) provide hardware acceleration by offloading sessions from the FPM-7620E
CPUs. The result is enhanced network performance provided by the NP6 processors plus the removal of network
processing load from the FPM-7620 CPUs. The NP6 processors can also handle some CPU-intensive tasks, like
IPsec VPN encryption/decryption. Because of the ISF in each FIM, all sessions are fast-pathed and accelerated.
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FPM-7620E hardware architecture

FIM-7901E fast path architecture
The FIM-7901E includes an integrated switch fabric (ISF) that connects the FIM front panel interfaces to the DP2
session-aware load balancers and to the chassis fabric and base backplanes. The ISF also allows the DP2
processors to distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the
FortiGate-7000 chassis.
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FIM-7901E schematic

FIM-7904E fast path architecture
The FIM-7904E includes an integrated switch fabric (ISF) that connects the front panel interfaces to the DP2
session-aware load balancers and to the chassis backplanes. The ISF also allows the DP2 processors to
distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the FortiGate-7000
chassis.

FIM-7904E hardware architecture
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FIM-7910E fast path architecture
The FIM-7910E includes an integrated switch fabric (ISF) that connects the front panel interfaces to the DP2
session-aware load balancers and to the chassis backplanes. The ISF also allows the DP2 processors to
distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the FortiGate-
7000chassis.

FIM-7910E hardware schematic

FIM-7920E fast path architecture
The FIM-7920E includes an integrated switch fabric (ISF) that connects the front panel interfaces to the DP2
session-aware load balancers and to the chassis backplanes. The ISF also allows the DP2 processors to
distribute sessions among all NP6 processors on the FortiGate Processor Modules (FPM) in the FortiGate-7000
chassis.
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FIM-7920E hardware schematic

FortiGate NP6lite architectures

This chapter shows the NP6lite architecture for the all FortiGate models that include NP6lite processors.

FortiGate-200E and 201E fast path architecture
The FortiGate-200E and 201E include two NP6lite processors. Because of this model does not include a switch
fabric, you cannot create Link Aggregation Groups (LAGs) or redundant interfaces between interfaces connected
to different NP6lites. As well traffic will only be offloaded if it enters and exits the FortiGate on interfaces
connected to the same NP6lite.

The NP6lites are connected to network interfaces as follows:

l NP6lite_0 is connected to six 1GERJ-45 interfaces (port9-port14) and four 1GE SFP interfaces (port15-18).
l NP6lite_1 is connected to ten 1GERJ45 interfaces (wan1, wan2, port1-port8).

The following diagram also shows the RGMII and QSGMII port connections between the NP6lite processors and
the front panel interfaces. Both RGMII and QSGMII interfaces operate at 1000Mbps. However, QSGMII
interfaces can also negotiate to operate at lower speeds: 10, 100, and 1000Mbps. To connect the FortiGate-
200E to networks with speeds lower than 1000Mbps use the QSGMII interfaces (port1-8 and port11-18).
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You can use the following get command to display the FortiGate-200E or 201E NP6lite configuration. You can
also use the diagnose npu np6lite port-list command to display this information.
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get hardware npu np6lite port-list
Chip XAUI Ports Max Cross-chip

Speed offloading
------ ---- ------- ----- ----------
np6lite_0

2 port9 1000M NO
1 port10 1000M NO
4 port11 1000M NO
3 port12 1000M NO
6 port13 1000M NO
5 port14 1000M NO
9 port15 1000M NO
10 port16 1000M NO
8 port17 1000M NO
7 port18 1000M NO

np6lite_1
2 wan1 1000M NO
1 wan2 1000M NO
4 port1 1000M NO
3 port2 1000M NO
6 port3 1000M NO
5 port4 1000M NO
8 port5 1000M NO
7 port6 1000M NO
10 port7 1000M NO
9 port8 1000M NO
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NP4 and NP4Lite Acceleration

NP4 network processors provide fastpath acceleration by offloading communication sessions from the FortiGate
CPU. When the first packet of a new session is received by an interface connected to an NP4 processor, just like
any session connecting with any FortiGate interface, the session is forwarded to the FortiGate CPU where it is
matched with a security policy. If the session is accepted by a security policy and if the session can be offloaded
its session key is copied to the NP4 processor that received the packet. All of the rest of the packets in the session
are intercepted by the NP4 processor and fast-pathed out of the FortiGate unit to their destination without ever
passing through the FortiGate CPU. The result is enhanced network performance provided by the NP4 processor
plus the network processing load is removed from the CPU. In addition, the NP4 processor can handle some CPU
intensive tasks, like IPsec VPN encryption/decryption.

NP4lite processors have the same architecture and function in the same way as NP4
processors. All of the descriptions of NP4 processors in this document can be applied
to NP4lite possessors except where noted.

Session keys (and IPsec SA keys) are stored in the memory of the NP4 processor that is connected to the
interface that received the packet that started the session. All sessions are fast-pathed and accelerated, even if
they exit the FortiGate unit through an interface connected to another NP4. The key to making this possible is the
Integrated Switch Fabric (ISF) that connects the NP4s and the FortiGate unit interfaces together. The ISF allows
any port connectivity. All ports and NP4s can communicate with each other over the ISF.

There are no special ingress and egress fast path requirements because traffic enters and exits on interfaces
connected to the same ISF. Most FortiGate models with multiple NP4 processors connect all interfaces and NP4
processors to the same ISF (except management interfaces) so this should not ever be a problem.

There is one limitation to keep in mind; the capacity of each NP4 processor. An individual NP4 processor has a
capacity of 20 Gbps (10 Gbps ingress and 10 Gbps egress). Once an NP4 processor hits its limit, sessions that
are over the limit are sent to the CPU. You can avoid this problem by as much as possible distributing incoming
sessions evenly among the NP4 processors. To be able to do this you need to be aware of which interfaces
connect to which NP4 processors and distribute incoming traffic accordingly.

Some FortiGate units contain one NP4 processor with all interfaces connected to it and to the ISF. As a result,
offloading is supported for traffic between any pair of interfaces.

Some FortiGate units include NP4Lite processors. These network processors have the same functionality and
limitations as NP4 processors but with about half the performance. Also, NP4Lite processors do not support
traffic shaping for offloaded sessions. NP4lite processors can be found in mid-range FortiGate models such as
the FortiGate-200D and 240D.

Viewing your FortiGate’s NP4 configuration
To list the NP4 network processors on your FortiGate unit, use the following CLI command.

get hardware npu np4 list

The output lists the interfaces that have NP4 processors. For example, for a FortiGate-5001C:

get hardware npu np4 list
ID Model Slot Interface
0 On-board port1 port2 port3 port4
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                               fabric1 base1 npu0-vlink0 npu0-vlink1
1 On-board port5 port6 port7 port8
                               fabric2 base2 npu1-vlink0 npu1-vlink1

NP4lite CLI commands (disabling NP4Lite offloading)

If your FortiGate unit includes an NP4Lite processor the following commands will be available:

l Use the following command to disable or enable NP4Lite offloading. By default NP4lite offloading is enabled. If you
want to disable NP4Lite offloading to diagnose a problem enter:

diagnose npu nplite fastpath disable

This command disables NP4Lite offloading until your FortiGate reboots. You can also re-enable offloading by
entering the following command:

diagnose npu nplite fastpath enable

l NP4lite debug command. Use the following command to debug NP4Lite operation:

diagnose npl npl_debug {<parameters>}

NP4Lite option to disable offloading ICMP traffic in IPsec tunnels

In some cases ICMP traffic in IPsec VPN tunnels may be dropped by the NP4Lite processor due to a bug with the
NP4Lite firmware. You can use the following command to avoid this problem by preventing the NP4Lite processor
from offloading ICMP sessions in IPsec VPN tunnels. This command is only available on FortiGate models with
NP4Lite processors, such as the FortiGate/FortiWiFi-60D.

config system npu
set process-icmp-by-host {disable | enable}

end

The option is disabled by default an all ICMP traffic in IPsec VPN tunnels is offloaded where possible. If you are
noticing that ICMP packets in IPsec VPN tunnels are being dropped you can disable this option and have all ICMP
traffic processed by the CPU and not offloaded to the NP4Lite.

NP4 and NP4Lite processors and sFlow and NetFlow
Configuring sFlow or NetFlow on any interface disables all NP4 or NP4Lite offloading for all traffic on that
interface.

Configuring NP4 traffic offloading
Offloading traffic to a network processor requires that the FortiGate unit configuration and the traffic itself is
suited to hardware acceleration. There are requirements for path the sessions and the individual packets.

NP4 session fast path requirements

Sessions must be fast path ready. Fast path ready session characteristics are:

l Layer 2 type/length must be 0x0800 (IEEE 802.1q VLAN specification is supported)
l Layer 3 protocol must be IPv4
l Layer 4 protocol must be UDP, TCP or ICMP
l Layer 3 / Layer 4 header or content modification must not require a session helper (for example, SNAT, DNAT, and

TTL reduction are supported, but application layer content modification is not supported)
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l Firewall policies must not include proxy-based security features (proxy-based virus scanning, proxy-based web
filtering, DNS filtering, DLP, Anti-Spam, VoIP, ICAP, Web Application Firewall, or Proxy options).

l If the FortiGate supports NTurbo, firewall policies can include flow-based security features (IPS, Application Control
CASI, flow-based antivirus, or flow-based web filtering) .

l Origin must not be local host (the FortiGate unit)

If you disable anomaly checks by Intrusion Prevention (IPS), you can still enable NP4
hardware accelerated anomaly checks using the fp-anomaly field of the
config system interface CLI command. See Offloading NP4 anomaly
detection on page 1693Offloading NP4 anomaly detection on page 1693

If a session is not fast path ready, the FortiGate unit will not send the session key to the network processor(s).
Without the session key, all session key lookup by a network processor for incoming packets of that session fails,
causing all session packets to be sent to the FortiGate unit’s main processing resources, and processed at normal
speeds.

If a session is fast path ready, the FortiGate unit will send the session key to the network processor(s). Session
key lookup then succeeds for subsequent packets from the known session.

Packet fast path requirements

Packets within the session must then also meet packet requirements.

l Incoming packets must not be fragmented.
l Outgoing packets must not require fragmentation to a size less than 385 bytes. Because of this requirement, the

configured MTU (Maximum Transmission Unit) for network processors’ network interfaces must also meet or
exceed the network processors’ supported minimum MTU of 385 bytes.

If packet requirements are not met, an individual packet will use FortiGate unit main processing resources,
regardless of whether other packets in the session are offloaded to the specialized network processor(s).

In some cases, due to these requirements, a protocol’s session(s) may receive a mixture of offloaded and non-
offloaded processing.

For example, FTP uses two connections: a control connection and a data connection. The control connection
requires a session helper, and cannot be offloaded, but the data connection does not require a session helper,
and can be offloaded. Within the offloadable data session, fragmented packets will not be offloaded, but other
packets will be offloaded.

Some traffic types differ from general offloading requirements, but still utilize some of the network processors’
encryption and other capabilities. Exceptions include IPsec traffic and active-active high availability (HA) load
balanced traffic.

Mixing fast path and non-fast path traffic

If packet requirements are not met, an individual packet will be processed by the FortiGate CPU regardless of
whether other packets in the session are offloaded to the NP4.

Also, in some cases, a protocol’s session(s) may receive a mixture of offloaded and non-offloaded processing.
For example, VoIP control packets may not be offloaded but VoIP data packets (voice packets) may be offloaded.
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Increasing NP4 offloading capacity using link aggregation groups (LAGs)
NP4 processors can offload sessions received by interfaces in link aggregation groups (LAGs) (IEEE 802.3ad). A
LAG combines more than one physical interface into a group that functions like a single interface with a higher
capacity than a single physical interface. For example, you could use a LAG if you want to offload sessions on a 3
Gbps link by adding three 1Gbps interfaces to the same LAG.

All offloaded traffic types are supported by LAGs, including IPsec VPN traffic. Just like with normal interfaces,
traffic accepted by a LAG is offloaded by the NP4 processor connected to the interfaces in the LAG that receive
the traffic to be offloaded. If all interfaces in a LAG are connected to the same NP4 processor, traffic received by
that LAG is offloaded by that NP4 processor. The amount of traffic that can be offloaded is limited by the capacity
of the NP4 processor.

If a FortiGate has two or more NP4 processors connected by an integrated switch fabric (ISF), you can use LAGs
to increase offloading by sharing the traffic load across multiple NP4 processors. You do this by adding physical
interfaces connected to different NP4 processors to the same LAG.

Adding a second NP4 processor to a LAG effectively doubles the offloading capacity of the LAG. Adding a third
further increases offloading. The actual increase in offloading capacity may not actually be doubled by adding a
second NP4 or tripled by adding a thrid. Traffic and load conditions and other factors may limit the actual
offloading result.

The increase in offloading capacity offered by LAGs and multiple NP4s is supported by the ISF that allows
multiple NP4 processors to share session information. On models that have more than one NP4 and no ISF, if
you attempt to add interfaces connected to different NP4 processors to a LAG the system displays an error
message.

There are also a few limitations to LAG NP4 offloading support for IPsec VPN:

l IPsec VPN anti-replay protection cannot be used if IPSec is configured on a LAG that has interfaces connected to
multiple NP4 processors.

l Using a LAG connected to multiple NP4 processors for decrypting incoming IPsec VPN traffic may cause some of
the incoming traffic to be decrypted by the CPU. So this configuration is not recommended since not all decryption
is offloaded. (Using a LAG connected to multiple NP4 processors for encrypting outgoing IPsec VPN traffic is
supported with no limitations.)

l Because the encrypted traffic for one IPsec VPN tunnel has the same 5-tuple, the traffic from one tunnel can only
can be balanced to one interface in a LAG. This limits the maximum throughput for one IPsec VPN tunnel in an NP4
LAG group to 1Gbps.

NP4 traffic shaping offloading
Accelerated Traffic shaping is supported by NP4 processors with the following limitations.

l NP4 processors support policy-based traffic shaping. However, fast path traffic and traffic handled by the FortiGate
CPU (slow path) are controlled separately, which means the policy setting on fast path does not consider the traffic
on the slow path.

l The port based traffic policing as defined by the inbandwidth and outbandwidth CLI commands is not supported.
l DSCP configurations are supported.
l Per-IP traffic shaping is supported.
l QoS in general is not supported.

NP4Lite processors do not support traffic shaping for offloaded sessions.
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You can also use the traffic shaping features of the FortiGate unit’s main processing resources by disabling NP4
offloding. See Disabling NP offloading for firewall policies on page 1598.

NP4 IPsec VPN offloading
NP4 processors improve IPsec tunnel performance by offloading IPsec encryption and decryption.

Requirements for hardware accelerated IPsec encryption or decryption are a modification of general offloading
requirements. Differing characteristics are:

l Origin can be local host (the FortiGate unit)
l In Phase 1 configuration, Local Gateway IPmust be specified as an IP address of a network interface for a port

attached to a network processor
l SAmust have been received by the network processor
l in Phase 2 configuration:

l encryption algorithm must be DES, 3DES, AES-128, AES-192, AES-256, or null
l authentication must be MD5, SHA1, or null
l if encryption is null, authentication must not also be null

To apply hardware accelerated encryption and decryption, the FortiGate unit’s main processing resources must
first perform Phase 1 negotiations to establish the security association (SA). The SA includes cryptographic
processing instructions required by the network processor, such as which encryption algorithmsmust be applied
to the tunnel. After ISAKMP negotiations, the FortiGate unit’s main processing resources send the SA to the
network processor, enabling the network processor to apply the negotiated hardware accelerated encryption or
decryption to tunnel traffic.

Possible accelerated cryptographic paths are:

l IPsec decryption offload
l Ingress ESP packet > Offloaded decryption > Decrypted packet egress (fast path)
l Ingress ESP packet > Offloaded decryption > Decrypted packet to FortiGate unit’s main processing resources

l IPsec encryption offload
l Ingress packet > Offloaded encryption > Encrypted (ESP) packet egress (fast path)
l Packet from FortiGate unit’s main processing resources > Offloaded encryption > Encrypted (ESP) packet

egress

Configuring Inter-VDOM link acceleration with NP4 processors
FortiGate units with NP4 processors include inter-VDOM links that can be used to accelerate inter-VDOM link
traffic.

Traffic is blocked if you enable IPS for traffic passing over inter-VDOM links if that
traffic is being offloaded by an NP4 processor.If you disable NP4 offloading traffic will
be allowed to flow. You can disable offloading in individual firewall policies by
disabling auto-asic-offload for those policies. You can also use the following
command to disable all IPS offloading

config ips global
set np-accel-mode none
set cp-accel-mode none

end
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l For a FortiGate unit with two NP4 processors there are also two inter-VDOM links, each with two interfaces:
l npu0-vlink:

npu0-vlink0
npu0-vlink1

l npu1-vlink:
npu1-vlink0
npu1-vlink1

These interfaces are visible from the GUI and CLI. For a FortiGate unit with NP4 interfaces, enter the following
CLI command (output shown for a FortiGate-5001B):

get hardware npu np4 list
ID Model Slot Interface
0 On-board port1 port2 port3 port4
                               fabric1 base1 npu0-vlink0 npu0-vlink1
1 On-board port5 port6 port7 port8
                               fabric2 base2 npu1-vlink0 npu1-vlink1

By default the interfaces in each inter-VDOM link are assigned to the root VDOM. To use these interfaces to
accelerate inter-VDOM link traffic, assign each interface in a pair to the VDOMs that you want to offload traffic
between. For example, if you have added a VDOM named New-VDOM to a FortiGate unit with NP4 processors,
you can go to System > Network > Interfaces and edit the npu0-vlink1 interface and set the Virtual Domain
to New-VDOM.
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This results in an inter-VDOM link between root and New-VDOM. You can also do this from the CLI:

config system interface
edit npu0-vlink1

set vdom New-VDOM
end

Using VLANs to add more accelerated Inter-VDOM links

You can add VLAN interfaces to the accelerated inter-VDOM links to create inter-VDOM links between more
VDOMs. For the links to work, the VLAN interfaces must be added to the same inter-VDOM link, must be on the
same subnet, and must have the same VLAN ID.

For example, to accelerate inter-VDOM link traffic between VDOMs named Marketing and Engineering using
VLANs with VLAN ID 100 go to System > Network > Interfaces and select Create New to create the VLAN
interface associated with the Marketing VDOM:

Name Marketing-link

Type VLAN

Interface npu0-vlink0

VLAN ID 100

Virtual Domain Marketing

IP/Network Mask 172.20.120.12/24

Create the inter-VDOM link associated with Engineering VDOM:

Name Engineering-link

Type VLAN

Interface npu0-vlink1

VLAN ID 100

Virtual Domain Engineering

IP/Network Mask 172.20.120.22/24

Or do the same from the CLI:
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config system interface
edit Marketing-link

set vdom Marketing
set ip 172.20.120.12/24
set interface npu0-vlink0
set vlanid 100

next
edit Engineering-link

set vdom Engineering
set ip 172.20.120.22/24
set interface npu0-vlink1
set vlanid 100

Confirm that the traffic is accelerated

Use the following CLI commands to obtain the interface index and then correlate them with the session entries.
In the following example traffic was flowing between new accelerated inter-VDOM links and physical ports port1
and port 2 also attached to the NP4 processor.

diagnose ip address list
IP=172.31.17.76->172.31.17.76/255.255.252.0 index=5 devname=port1
IP=10.74.1.76->10.74.1.76/255.255.252.0 index=6 devname=port2
IP=172.20.120.12->172.20.120.12/255.255.255.0 index=55 devname=IVL-VLAN1_ROOT
IP=172.20.120.22->172.20.120.22/255.255.255.0 index=56 devname=IVL-VLAN1_VDOM1

diagnose sys session list
session info: proto=1 proto_state=00 duration=282 expire=24 timeout=0 session info:

proto=1 proto_state=00 duration=124 expire=59 timeout=0 flags=00000000
sockflag=00000000 sockport=0 av_idx=0 use=3

origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/
state=may_dirty npu
statistic(bytes/packets/allow_err): org=180/3/1 reply=120/2/1 tuples=2
orgin->sink: org pre->post, reply pre->post dev=55->5/5->55

gwy=172.31.19.254/172.20.120.22
hook=post dir=org act=snat 10.74.2.87:768->10.2.2.2:8(172.31.17.76:62464)
hook=pre dir=reply act=dnat 10.2.2.2:62464->172.31.17.76:0(10.74.2.87:768)
misc=0 policy_id=4 id_policy_id=0 auth_info=0 chk_client_info=0 vd=0
serial=0000004e tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
per_ip_bandwidth meter: addr=10.74.2.87, bps=880
npu_state=00000000
npu info: flag=0x81/0x81, offload=4/4, ips_offload=0/0, epid=160/218, ipid=218/160,

vlan=32769/0

session info: proto=1 proto_state=00 duration=124 expire=20 timeout=0 flags=00000000
sockflag=00000000 sockport=0 av_idx=0 use=3

origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/
state=may_dirty npu
statistic(bytes/packets/allow_err): org=180/3/1 reply=120/2/1 tuples=2
orgin->sink: org pre->post, reply pre->post dev=6->56/56->6

gwy=172.20.120.12/10.74.2.87
hook=pre dir=org act=noop 10.74.2.87:768->10.2.2.2:8(0.0.0.0:0)
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hook=post dir=reply act=noop 10.2.2.2:768->10.74.2.87:0(0.0.0.0:0)
misc=0 policy_id=3 id_policy_id=0 auth_info=0 chk_client_info=0 vd=1
serial=0000004d tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
per_ip_bandwidth meter: addr=10.74.2.87, bps=880
npu_state=00000000
npu info: flag=0x81/0x81, offload=4/4, ips_offload=0/0, epid=219/161, ipid=161/219,

vlan=0/32769
total session 2

Offloading NP4 anomaly detection
Network interfaces associated with a port attached to an NP4 processor can be configured to offload anomaly
checking to the NP4 processor. This anomaly checking happens before other offloading and separately from DoS
policy anomaly checking. Using the following command, each FortiGate interface can have a different anomaly
checking configuration even if they are connected to the same NP4 processor.

The options available for this command apply anomaly checking for NP4 sessions in
the same way as the command descrbed in Configuring individual NP6 processors on
page 1614 applies anomaly checking for for NP6 sessions.

config system interface
edit <port-name>

set fp-anomaly <anomalies>
end

where <anomalies> can be one, more than one or all of the following:

Anomaly Description

drop_icmp_frag Drop ICMP fragments to pass.

drop_icmpland Drop ICMP Land.

drop_ipland Drop IP Land.

drop_iplsrr Drop IP with Loose Source Record Route option.

drop_iprr Drop IP with Record Route option.

drop_ipsecurity Drop IP with Security option.

drop_ipssrr Drop IP with Strict Source Record Route option.

drop_ipstream Drop IP with Stream option.

drop_iptimestamp Drop IP with Timestamp option.

drop_ipunknown_
option Drop IP with malformed option.
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Anomaly Description

drop_ipunknown_
prot

Drop IP with Unknown protocol.

drop_tcp_fin_
noack Drop TCP FIN with no ACT flag set to pass.

drop_tcp_no_flag Drop TCPwith no flag set to pass.

drop_tcpland Drop TCP Land.

drop_udpland Drop UDP Land.

drop_winnuke Drop TCPWinNuke.

pass_icmp_frag Allow ICMP fragments to pass.

pass_icmpland Allow ICMP Land to pass.

pass_ipland Allow IP land to pass.

pass_iplsrr Allow IP with Loose Source Record Route option to pass.

pass_iprr Allow IP with Record Route option to pass.

pass_ipsecurity Allow IP with Security option to pass.

pass_ipssrr Allow IP with Strict Source Record Route option to pass.

pass_ipstream Allow IP with Stream option to pass.

pass_iptimestamp Allow IP with Timestamp option to pass.

pass_ipunknown_
option Allow IP with malformed option to pass.

pass_ipunknown_
prot

Allow IP with Unknown protocol to pass.

pass_tcp_fin_
noack Allow TCP FIN with no ACT flag set to pass.

pass_tcp_no_flag Allow TCPwith no flag set to pass.

pass_tcpland Allow TCP Land to pass.

pass_udpland Allow UDP Land to pass.

pass_winnuke Allow TCPWinNuke to pass.
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Example

You might configure an NP4 to drop packets with TCPWinNuke or unknown IP protocol anomalies, but to pass
packets with an IP time stamp, using hardware acceleration provided by the network processor.

config system interface
edit port1

set fp-anomaly drop_winnuke drop_ipunknown_prot pass_iptimestamp
end
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FortiGate NP4 architectures

This chapter shows the NP4 architecture for the all FortiGate models that include NP4 processors.

FortiGate-600C
The FortiGate-600C features one NP4 processor. All the ports are connected to this NP4 over the Integrated
Switch Fabric. Port1 and port2 are dual failopen redundant RJ-45 ports. Port3-port22 are RJ-45 ethernet ports,
and there are four 1Gb SFP interface ports duplicating the port19-port22 connections.
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FortiGate-800C
The FortiGate-800C features one NP4 processor. All the ports are connected to this NP4. Port1 and port2 are
dual failopen redundant RJ-45 ports. Port3-port22 are RJ-45 Ethernet ports, and there are eight 1Gb SFP
interface ports duplicating the port15-18 and port19-port22 connections. There are also two 10Gb SFP+ ports,
port23 and port24.
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FortiGate-1000C
The FortiGate-1000C features one NP4 processor. All the ports are connected to this NP4. Port1 and port2 are
dual failopen redundant RJ-45 ports. Port3-port22 are RJ-45 ethernet ports, and there are eight 1Gb SFP
interface ports duplicating the port15-18 and port19-port22 connections. There are also two 10Gb SFP+ ports,
port23 and port24.
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FortiGate-1240B
The FortiGate-1240B features two NP4 processors:

l Port1 to port24 are 1Gb SFP interfaces connected to one NP4 processor.
l Port25 to port38 are RJ-45 ethernet ports, connected to the other NP4 processor.
l Port39 and port40 are not connected to an NP4 processor.
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FortiGate-3040B
The FortiGate-3040B features two NP4 processors:

l The 10Gb interfaces, port1, port2, port3, port4, and the 1Gb interfaces, port9, port10, port11, port12, port13, share
connections to one NP4 processor.

l The 10Gb interfaces, port5, port6, port7, port8, and the 1Gb interfaces, port14, port15, port16, port17, port18,
share connections to the other NP4 processor.
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FortiGate-3140B
The FortiGate-3140B features two NP4 processors and one SP2 processor:

l The 10Gb interfaces, port1, port2, port3, port4, and the 1Gb interfaces, port9, port10, port11, port12, port13, share
connections to one NP4 processor.

l The 10Gb interfaces, port5, port6, port7, port8, and the 1Gb interfaces, port14, port15, port16, port17, port18,
share connections to the other NP4 processor.

l The 10Gb interfaces, port19 and port20, share connections to the SP2 processor.
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FortiGate-3140B — load balance mode
The FortiGate-3140B load balance mode allows you increased flexibility in how you use the interfaces on the
FortiGate unit. When enabled, traffic between any two interfaces (excluding management and console) is
accelerated. Traffic is not limited to entering and leaving the FortiGate unit in specific interface groupings to
benefit from NP4 and SP2 acceleration. You can use any pair of interfaces.

Security acceleration in this mode is limited, however. Only IPS scanning is accelerated in load balance mode.
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To enable this feature, issue this CLI command.

config system global
set sp-load-balance enable

end

The FortiGate unit will then restart.

To return to the default mode, issue this CLI command.

config system global
set sp-load-balance disable

end

FortiGate-3240C
The FortiGate-3240C features two NP4 processors:
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l The 10Gb interfaces, port1 through port6, and the 1Gb interfaces, port13 through port20, share connections to one
NP4 processor.

l The 10Gb interfaces, port7 through port12, and the 1Gb interfaces, port21 through port28, share connections to the
other NP4 processor.

In addition to the ports being divided between the two NP4 processors, they are further divided between the two
connections to each processor. Each NP4 can process 20 Gb of network traffic per second and each of two
connections to each NP4 can move 10Gb of data to the processor per second, so the ideal configuration would
have no more than 10 Gb of network traffic to each connection of each NP4 at any time.
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FortiGate-3600C
The FortiGate-3600C features three NP4 processors:

l The 10Gb interfaces, port1-port4, and the 1Gb interfaces, port13-port17, share connections to one NP4 processor.
l The 10Gb interfaces, port5-port8, and the 1Gb interfaces, port18-port22 share connections to the second NP4

processor.
l The 10Gb interfaces, port9-port12, and the 1Gb interfaces, port23-port28 share connections to the third NP4

processor.
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FortiGate-3600C XAUI links

The FortiGate-3600C uses XAUI links for communication between physical Ethernet ports and the integrated
switch fabric.

Each XAUI link has a maximum bandwidth of 10-Gigabits. The reason you may need to know about the XAUI link
in NP4 configurations is because of this 10-Gigabit limit. Because of this limitation, the total amount of data
processed by all Ethernet interfaces connected to an XAUI link cannot exceed 10 gigabits. In some cases this
may limit the amount of bandwidth that the FortiGate can process.

Each NP4 processor connects to the integrated switch fabric through two XAUI links: XAUI0 and XAUI1. All of the
odd numbered Ethernet interfaces use XAU0 and all of the even numbered interfaces use XAUI1:

NPU1

XAUI0 = port1,port3,port13, port15, port17

XAUI1 = port2, port4, port14, port16

NPU2

XAUI0 = port5, port7, port18, port20, port22

XAUI1 = port6, port8, port19, port21

NPU3

XAUI0 = port9, port11, port23, port25, port27

XAUI1 = port10, port12, port24, port26, port28

Usually you do not have to be concerned about XAUI link mapping. However, if a FortiGate-3600C NP4 interface
is processing a very high amount of traffic you should distribute that traffic among both of the XAUI links
connected to it. So if you have a very high volume of traffic flowing between two networks you should connect
both networks to the same NP4 processor but to different XAUI links. For example, you could connect one
network to Ethernet port5 and the other network to Ethernet port6. In this configuration, the second NP4
processor would handle traffic acceleration and both XAUI links would be processing traffic.

FortiGate-3950B and FortiGate-3951B
The FortiGate-3950B features one NP4 processor. The 1Gb SPF interfaces, port1, port2, port3, port4, and the
10Gb SPF+ interfaces, port5, port6, share connections to one NP4 processor. The FortiGate-3951B is similar to
the FortiGate-3950B, except it trades one FMC slot for four FSM slots. The network interfaces available on each
model are identical.

You can add additional FMC interface modules. The diagram below shows a FortiGate-3950B with three
modules installed: an FMC-XG2, an FMC-F20, and an FMC-C20.

l The FMC-XG2 has one SP2 processor. The 10Gb SPF+ interfaces, port1 and port2, share connections to the
processor.

l The FMC-F20 has one NP4 processor and the twenty 1Gb SPF interfaces, port1 through port20, share connections
to the NP4 processor.
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l The FMC-C20 has one NP4 processor and the twenty 10/100/1000 interfaces, port1 through port20, share
connections to the NP4 processor.
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FortiGate-3950B and FortiGate-3951B — load balance mode
Adding one or more FMC-XG2 modules to your FortiGate-3950B allows you to enable load balance mode. This
feature allows you increased flexibility in how you use the interfaces on the FortiGate unit. The FortiGate-3951B
is similar to the FortiGate-3950B, except it trades one FMC slot for four FSM slots. The network interfaces
available on each model are identical.

When enabled, traffic between any two interfaces (excluding management and console) is accelerated whether
they are the six interfaces on the FortiGate-3950B itself, or on any installed FMCmodules. Traffic is not limited to
entering and leaving the FortiGate unit in specific interface groupings to benefit from NP4 and SP2 acceleration.
You can use any pair of interfaces.

Security acceleration in this mode is limited, however. Only IPS scanning is accelerated in load balance mode.

The FortiGate-3950B in load balance mode
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To enable this feature, issue this CLI command.

config system global
set sp-load-balance enable

end
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The FortiGate unit will then restart.

To return to the default mode, issue this CLI command.

config system global
set sp-load-balance disable

end

FortiGate-5001C
The FortiGate-5001C board includes two NP4 processors connected to an integrated switch fabric:

l The port1, fabric1, and base1 interfaces are connected to one NP4 processor.
l The port2, fabric2, and base2 interfaces are connected to the other NP4 processor.
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FortiGate-5001B
The FortiGate-5001B board includes two NP4 connected to an integrated switch fabric.

l The port1, port2, port3, port4, fabric1 and base1 interfaces are connected to one NP4 processor.
l The port5, port6, port7, port8, fabric2 and base2 interfaces are connected to the other NP4 processor.
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Setting switch-mode mapping on the ADM-XD4
The ADM-XD4 SP has four 10Gb/s ports, but the NP4 processor it contains has only two 10Gb/s ports. The
external ports you use are important to optimize the SP for your application.

ADM-XD4 mapping mode

Ports 1 and 3 share one NP4 processor and ports 2 and 4 share the other. Performance ports sharing the same
NP4 processor is far better than when forcing network data to move between NP4 processors by using one port
from each, for example ports 1 and 2 or ports 3 and 4.

Hardware acceleration get and diagnose commands

This section describes some get and diagnose commands you can use to display useful information about the
NP6 processors sessions processed by NP6 processors.

get hardware npu np6
You can use the get hardware npu np6 command to display information about the NP6 processors in your
FortiGate and the sessions they are processing. This command contains a subset of the options available from
the diagnose npu np6 command. The command syntax is:

get hardware npu np6 {dce <np6-id> | ipsec-stats | port-list | session-stats <np6-id> |
sse-stats <np6-id> | synproxy-stats}

<np6-id> identifies the NP6 processor. 0 is np6_0, 1 is np6_1 and so on.

dce show NP6 non-zero sub-engine drop counters for the selected NP6.

ipsec-stats show overall NP6 IPsec offloading statistics.

port-list show the mapping between the FortiGate's physical ports and its NP6 processors.

session-stats show NP6 session offloading statistics counters for the selected NP6.

sse-stats show hardware session statistics counters.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1710



Hardware acceleration get and diagnose commands Chapter 14 - Hardware Acceleration

synproxy-stats show overall NP6 synproxy statistics for TCP connections identified as being syn proxy DoS
attacks.

diagnose npu np6
The diagnose npu np6 command displays extensive information about NP6 processors and the sessions that they
are processing. Some of the information displayed can be useful for understanding the NP6 configuration, seeing
how sessions are being processed and diagnosing problems. Some of the commands may only be useful for
Fortinet software developers. The command syntax is:

diagnose npu np6 {options}

The following options are available:

fastpath {disable | enable} <np6-od> enable or disable fastpath processing for a selected NP6.

dce shows NP6 non-zero sub-engine drop counters for the selected NP6.

dce-all show all subengine drop counters.

anomaly-drop show non-zero L3/L4 anomaly check drop counters.

anomaly-drop-all show all L3/L4 anomaly check drop counters.

hrx-drop show non-zero host interface drop counters.

hrx-drop-all show all host interface drop counters.

session-stats show session offloading statistics counters.

session-stats-clear clear sesssion offloading statistics counters.

sse-stats show hardware session statistics counters.

sse-stats-clear show hardware session statistics counters.

pdq show packet buffer queue counters.

xgmac-stats show XGMACMIBs counters.

xgmac-stats-clear clear XGMACMIBS counters.

port-list show port list.

ipsec-stats show IPsec offloading statistics.

ipsec-stats-clear clear IPsec offloading statistics.

eeprom-read read NP6 EEPROM.

npu-feature show NPU feature and status.

register show NP6 registers.

fortilink configure fortilink.

synproxy-stats show synproxy statistics.
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Using diagnose npu np6 npu-feature to verify enabled NP6 features
You can use the diagnose npu np6 npu-feature command to see what NP6 features are enabled and
which are not. The following command output shows the normal default NP6 configuration for most FortiGates.
In this output all features are enabled except low latency features and GRE offloading. Low latency is only
available on the FortiGate-3700D and DXmodels and GRE offloading will become available in a future FortiOS
release. The following output is from a FortiGate-1500D

diagnose npu np6 npu-feature
np_0 np_1

------------------- --------- ---------
Fastpath Enabled Enabled
Low-latency-mode Disabled Disabled
Low-latency-cap No No
IPv4 firewall Yes Yes
IPv6 firewall Yes Yes
IPv4 IPSec Yes Yes
IPv6 IPSec Yes Yes
IPv4 tunnel Yes Yes
IPv6 tunnel Yes Yes
GRE tunnel No No
IPv4 Multicast Yes Yes
IPv6 Multicast Yes Yes
CAPWAP Yes Yes

If you use the following command to disable fastpath for np_0:

config system np6
edit np6_0

set fastpath disable
end

The npu-feature command output show this configuration change:

diagnose npu np6 npu-feature
np_0 np_1

------------------- --------- ---------
Fastpath Disabled Enabled
Low-latency-mode Disabled Disabled
Low-latency-cap No No
IPv4 firewall Yes Yes
IPv6 firewall Yes Yes
IPv4 IPSec Yes Yes
IPv6 IPSec Yes Yes
IPv4 tunnel Yes Yes
IPv6 tunnel Yes Yes
GRE tunnel No No
IPv4 Multicast Yes Yes
IPv6 Multicast Yes Yes
CAPWAP Yes Yes
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Using the diagnose sys session/session6 list command
The diagnose sys session list and diagnose sys session6 list commands list all of the
current IPv4 or IPv6 sessions being processed by the FortiGate. For each session the command output includes
an npu info line that displays NPx offloading information for the session. If a session is not offloaded the
command output includes a no_ofld_reason line that indicates why the session was not offloaded.

Displaying NP6 offloading information for a session

The npu info line of the diagnose sys session list command includes information about the
offloaded session that indicates the type of processor and whether its IPsec or regular traffic:

l offload=1/1 for NP1(FA1) sessions.
l offload=2/2 for NP1(FA2) sessions.
l offload=3/3 for NP2 sessions.
l offload=4/4 for NP4 sessions.
l offload=5/5 for XLR sessions.
l offload=6/6 for Nplite/NP4lite sessions.
l offload=7/7 for XLP sessions.
l offload=8/8 for NP6 sessions.
l flag 0x81 means regular traffic.
l flag 0x82 means IPsec traffic.

Example offloaded IPv4 NP6 session

The following session output by the diagnose sys session list command shows an offloaded session.
The information in the npu info line shows this is a regular session (flag=0x81/0x81) that is offloaded by
an NP6 processor (offload=8/8).

diagnose sys session list
session info: proto=6 proto_state=01 duration=4599 expire=2753 timeout=3600 flags-
s=00000000 sockflag=00000000 sockport=0 av_idx=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/ vlan_cos=0/255
state=log may_dirty npu none log-start
statistic(bytes/packets/allow_err): org=1549/20/1 reply=1090/15/1 tuples=2
speed(Bps/kbps): 0/0
orgin->sink: org pre->post, reply pre->post dev=15->17/17->15
gwy=172.20.121.2/5.5.5.33
hook=post dir=org act=snat 5.5.5.33:60656->91.190.218.66:12350
(172.20.121.135:60656)
hook=pre dir=reply act=dnat 91.190.218.66:12350->172.20.121.135:60656
(5.5.5.33:60656)
pos/(before,after) 0/(0,0), 0/(0,0)
src_mac=98:90:96:af:89:b9
misc=0 policy_id=1 auth_info=0 chk_client_info=0 vd=0
serial=00058b9c tos=ff/ff app_list=0 app=0 url_cat=0
dd_type=0 dd_mode=0
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npu_state=0x000c00
npu info: flag=0x81/0x81, offload=8/8, ips_offload=0/0, epid=140/138, ipid-
d=138/140, vlan=0x0000/0x0000
vlifid=138/140, vtag_in=0x0000/0x0000 in_npu=1/1, out_npu=1/1, fwd_en=0/0, qid=0/2

Example IPv4 session that is not offloaded

The following session, output by the diagnose sys session list command includes the no_ofld_reason line
that indicates that the session was not offloaded because it is a local-in session.

session info: proto=6 proto_state=01 duration=19 expire=3597 timeout=3600
flags=00000000 sockflag=00000000 sockport=0 av_idx=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/ vlan_cos=8/8
state=local may_dirty
statistic(bytes/packets/allow_err): org=6338/15/1 reply=7129/12/1 tuples=2
speed(Bps/kbps): 680/5
orgin->sink: org pre->in, reply out->post dev=15->50/50->15 gwy=5.5.5.5/0.0.0.0
hook=pre dir=org act=noop 5.5.5.33:60567->5.5.5.5:443(0.0.0.0:0)
hook=post dir=reply act=noop 5.5.5.5:443->5.5.5.33:60567(0.0.0.0:0)
pos/(before,after) 0/(0,0), 0/(0,0)
src_mac=98:90:96:af:89:b9
misc=0 policy_id=0 auth_info=0 chk_client_info=0 vd=0
serial=000645d8 tos=ff/ff app_list=0 app=0 url_cat=0
dd_type=0 dd_mode=0
npu_state=00000000
no_ofld_reason: local

Example IPv4 IPsec NP6 session

diagnose sys session list
session info: proto=6 proto_state=01 duration=34 expire=3565 timeout=3600 flags-
s=00000000 sockflag=00000000 sockport=0 av_idx=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/p1-vdom2
state=re may_dirty npu
statistic(bytes/packets/allow_err): org=112/2/1 reply=112/2/1 tuples=2
orgin->sink: org pre->post, reply pre->post dev=57->7/7->57 gwy-
y=10.1.100.11/11.11.11.1
hook=pre dir=org act=noop 172.16.200.55:35254->10.1.100.11:80(0.0.0.0:0)
hook=post dir=reply act=noop 10.1.100.11:80->172.16.200.55:35254(0.0.0.0:0)
pos/(before,after) 0/(0,0), 0/(0,0)
misc=0 policy_id=1 id_policy_id=0 auth_info=0 chk_client_info=0 vd=4
serial=00002d29 tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
per_ip_bandwidth meter: addr=172.16.200.55, bps=260
npu_state=00000000
npu info: flag=0x81/0x82, offload=8/8, ips_offload=0/0, epid=1/3, ipid=3/1, vlan-
n=32779/0
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Example IPv6 NP6 session

diagnose sys session6 list
session6 info: proto=6 proto_state=01 duration=2 expire=3597 timeout=3600 flags-
s=00000000 sockport=0 sockflag=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0
policy_dir=0 tunnel=/
state=may_dirty npu
statistic(bytes/packets/allow_err): org=152/2/0 reply=152/2/0 tuples=2
speed(Bps/kbps): 0/0
orgin->sink: org pre->post, reply pre->post dev=13->14/14->13
hook=pre dir=org act=noop 2000:172:16:200::55:59145 ->2000:10:1:100::11:80(:::0)
hook=post dir=reply act=noop 2000:10:1:100::11:80 ->2000:172:16:200::55:59145
(:::0)
misc=0 policy_id=1 auth_info=0 chk_client_info=0 vd=0 serial=0000027a
npu_state=0x000c00
npu info: flag=0x81/0x81, offload=8/8, ips_offload=0/0, epid=137/136, ipid-
d=136/137, vlan=0/0
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Example NAT46 NP6 session

diagnose sys session list
session info: proto=6 proto_state=01 duration=19 expire=3580 timeout=3600 flags-
s=00000000 sockflag=00000000 sockport=0 av_idx=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/
state=npu nlb
statistic(bytes/packets/allow_err): org=112/2/1 reply=112/2/1 tuples=2
speed(Bps/kbps): 0/0
orgin->sink: org nataf->post, reply pre->org dev=52->14/14->52 gwy-
y=0.0.0.0/10.1.100.1
hook=5 dir=org act=noop 10.1.100.1:21937->10.1.100.11:80(0.0.0.0:0)
hook=6 dir=reply act=noop 10.1.100.11:80->10.1.100.1:21937(0.0.0.0:0)
hook=pre dir=org act=noop 2000:172:16:200::55:33945 ->64:ff9b::a01:640b:80(:::0)
hook=post dir=reply act=noop 64:ff9b::a01:640b:80 ->2000:172:16:200::55:33945
(:::0)
pos/(before,after) 0/(0,0), 0/(0,0)
misc=0 policy_id=1 auth_info=0 chk_client_info=0 vd=0
serial=04051aae tos=ff/ff ips_view=0 app_list=0 app=0
dd_type=0 dd_mode=0
npu_state=00000000
npu info: flag=0x81/0x00, offload=0/8, ips_offload=0/0, epid=0/136, ipid=0/137,
vlan=0/0

Example NAT64 NP6 session

diagnose sys session6 list
session6 info: proto=6 proto_state=01 duration=36 expire=3563 timeout=3600 flags-
s=00000000 sockport=0 sockflag=0 use=3
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0
policy_dir=0 tunnel=/
state=may_dirty npu nlb
statistic(bytes/packets/allow_err): org=72/1/0 reply=152/2/0 tuples=2
speed(Bps/kbps): 0/0
orgin->sink: org pre->org, reply nataf->post dev=13->14/14->13
hook=pre dir=org act=noop 2000:172:16:200::55:33945 ->64:ff9b::a01:640b:80(:::0)
hook=post dir=reply act=noop 64:ff9b::a01:640b:80 ->2000:172:16:200::55:33945
(:::0)
hook=5 dir=org act=noop 10.1.100.1:21937->10.1.100.11:80(0.0.0.0:0)
hook=6 dir=reply act=noop 10.1.100.11:80->10.1.100.1:21937(0.0.0.0:0)
misc=0 policy_id=1 auth_info=0 chk_client_info=0 vd=0 serial=0000027b
npu_state=00000000
npu info: flag=0x00/0x81, offload=8/0, ips_offload=0/0, epid=137/0, ipid=136/0,
vlan=0/0
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diagnose npu np6 session-stats <np6-id> (number of NP6 IPv4 and IPv6 sessions)
You can use the diagnose npu np6 portlist command to list the NP6-ids and the interfaces that each
NP6 is connected to. The <np6-id> of np6_0 is 0, the <np6-id> of np6_1 is 1 and so on. The diagnose npu
np6 session-stats <np6-id> command output incudes the following headings:

l ins44 installed IPv4 sessions
l ins46 installed NAT46 sessions
l del4 deleted IPv4 and NAT46 sessions
l ins64 installed NAT64 sessions
l ins66 installed IPv6 sessions
l del6 deleted IPv6 and NAT64 sessions
l e is the error counter for each session type

diagnose npu np6 session-stats 0
qid ins44 ins46 del4 ins64 ins66 del6

ins44_e ins46_e del4_e ins64_e ins66_e del6_e
---------------- ---------- ---------- ---------- ---------- ----------
0 94 0 44 0 40 30

0 0 0 0 0 0
1 84 0 32 0 30 28

0 0 0 0 0 0
2 90 0 42 0 40 30

0 0 0 0 0 0
3 86 0 32 0 24 27

0 0 0 0 0 0
4 72 0 34 0 34 28

0 0 0 0 0 0
5 86 0 30 0 28 32

0 0 0 0 0 0
6 82 0 38 0 32 34

0 0 0 0 0 0
7 86 0 30 0 30 30

0 0 0 0 0 0
8 78 0 26 0 36 26

0 0 0 0 0 0
9 86 0 34 0 32 32

0 0 0 0 0 0
---------------- ---------- ---------- ---------- ---------- ----------
Total 844 0 342 0 326 297

0 0 0 0 0 0
---------------- ---------- ---------- ---------- ---------- ----------
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diagnose npu np6 ipsec-stats (NP6 IPsec statistics)
The command output includes IPv4, IPv6, and NAT46 IPsec information:

l spi_ses4 is the IPv4 counter
l spi_ses6 is the IPv6 counter
l 4to6_ses is the NAT46 counter

diagnose npu np6 ipsec-stats
vif_start_oid 03ed vif_end_oid 03fc
IPsec Virtual interface stats:
vif_get 00000000000 vif_get_expired 00000000000
vif_get_fail 00000000000 vif_get_invld 00000000000
vif_set 00000000000 vif_set_fail 00000000000
vif_clear 00000000000 vif_clear_fail 00000000000
np6_0:
sa_install 00000000000 sa_ins_fail 00000000000
sa_remove 00000000000 sa_del_fail 00000000000
4to6_ses_ins 00000000000 4to6_ses_ins_fail 00000000000
4to6_ses_del 00000000000 4to6_ses_del_fail 00000000000
spi_ses6_ins 00000000000 spi_ses6_ins_fail 00000000000
spi_ses6_del 00000000000 spi_ses6_del_fail 00000000000
spi_ses4_ins 00000000000 spi_ses4_ins_fail 00000000000
spi_ses4_del 00000000000 spi_ses4_del_fail 00000000000
sa_map_alloc_fail 00000000000 vif_alloc_fail 00000000000
sa_ins_null_adapter 00000000000 sa_del_null_adapter 00000000000
del_sa_mismatch 00000000000 ib_chk_null_adpt 00000000000
ib_chk_null_sa 00000000000 ob_chk_null_adpt 00000000000
ob_chk_null_sa 00000000000 rx_vif_miss 00000000000
rx_sa_miss 00000000000 rx_mark_miss 00000000000
waiting_ib_sa 00000000000 sa_mismatch 00000000000
msg_miss 00000000000
np6_1:
sa_install 00000000000 sa_ins_fail 00000000000
sa_remove 00000000000 sa_del_fail 00000000000
4to6_ses_ins 00000000000 4to6_ses_ins_fail 00000000000
4to6_ses_del 00000000000 4to6_ses_del_fail 00000000000
spi_ses6_ins 00000000000 spi_ses6_ins_fail 00000000000
spi_ses6_del 00000000000 spi_ses6_del_fail 00000000000
spi_ses4_ins 00000000000 spi_ses4_ins_fail 00000000000
spi_ses4_del 00000000000 spi_ses4_del_fail 00000000000
sa_map_alloc_fail 00000000000 vif_alloc_fail 00000000000
sa_ins_null_adapter 00000000000 sa_del_null_adapter 00000000000
del_sa_mismatch 00000000000 ib_chk_null_adpt 00000000000
ib_chk_null_sa 00000000000 ob_chk_null_adpt 00000000000
ob_chk_null_sa 00000000000 rx_vif_miss 00000000000
rx_sa_miss 00000000000 rx_mark_miss 00000000000
waiting_ib_sa 00000000000 sa_mismatch 00000000000
msg_miss 00000000000

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1718



Hardware acceleration get and diagnose commands Chapter 14 - Hardware Acceleration

diagnose sys mcast-session/session6 list (IPv4 and IPv6 multicast sessions)
This command lists all IPv4 or IPv6 multicast sessions. If a multicast session can be offloaded, the output
includes the offloadable tag. If the multicast path can be offloaded one of the paths in the command output
is tagged as offloaded.

The only way to determine the number of offloaded multicast sessions is to use the diagnose sys mcast-
session/session6 list command and count the number of sessions with the offload tag.

diagnose sys mcast-session list
session info: id=3 vf=0 proto=17 172.16.200.55.51108->239.1.1.1.7878
used=2 path=11 duration=1 expire=178 indev=6 pkts=2 state:2cpu offloadable
npu-info in-pid=0 vifid=0 in-vtag=0 npuid=0 queue=0 tae=0

path: 2cpu policy=1, outdev=2
        out-vtag=0
path: 2cpu policy=1, outdev=3
        out-vtag=0
path: offloaded policy=1, outdev=7
        out-vtag=0
path: policy=1, outdev=8
        out-vtag=0
path: policy=1, outdev=9
        out-vtag=0
path: policy=1, outdev=10
        out-vtag=0
path: policy=1, outdev=11
        out-vtag=0
path: policy=1, outdev=12
        out-vtag=0
path: policy=1, outdev=13
        out-vtag=0
path: 2cpu policy=1, outdev=64
      out-vtag=0
path: 2cpu policy=1, outdev=68
      out-vtag=0
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diagnose npu np6 sse-stats <np6-id> (number of NP6 sessions and dropped sessions)
This command displays the total number of inserted, deleted and purged sessions processed by a selected NP6
processor. The number of dropped sessions of each type cam be determined by subtracting the number of
successfull sessions from the total number of sessions. For example, the total number of dropped insert sessions
is insert-total - insert-success.

diagnose npu np6 sse-stats 0
Counters SSE0 SSE1 Total
--------------- --------------- --------------- ---------------
active 0 0 0
insert-total 25 0 0
insert-success 25 0 0
delete-total 25 0 0
delete-success 25 0 0
purge-total 0 0 0
purge-success 0 0 0
search-total 40956 38049 79005
search-hit 37714 29867 67581
--------------- --------------- --------------- ---------------
pht-size 8421376 8421376
oft-size 8355840 8355840
oftfree 8355839 8355839
PBA 3001

diagnose npu np6 dce <np6-id> (number of dropped NP6 packets)
This command displays the number of dropped packets for the selected NP6 processor.

l IHP1_PKTCHK number of dropped IP packets
l IPSEC0_ENGINB0 number of dropped IPSec
l TPE_SHAPER number of dropped traffic sharper packets

diag npu np6 dce 1
IHP1_PKTCHK :0000000000001833 [5b] IPSEC0_ENGINB0 :0000000000000003 [80]
TPE_SHAPER :0000000000000552 [94]
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diagnose hardware deviceinfo nic <interfac-name> (number of packets dropped by an
interface)

This command displays a wide variety of statistics for FortiGate interfaces. The fields Host Rx dropped and
Host Tx dropped display the number of received and trasmitted packets that have been dropped.

diagnose hardware deviceinfo nic port2
...
============ Counters ===========
Rx Pkts         :20482043
Rx Bytes        :31047522516
Tx Pkts         :19000495
Tx Bytes        :1393316953
Host Rx Pkts    :27324
Host Rx Bytes   :1602755
Host Rx dropped :0
Host Tx Pkts    :8741
Host Tx Bytes   :5731300
Host Tx dropped :0
sw_rx_pkts      :20482043
sw_rx_bytes     :31047522516
sw_tx_pkts      :19000495
sw_tx_bytes     :1393316953
sw_np_rx_pkts   :19000495
sw_np_rx_bytes  :1469318933
sw_np_tx_pkts   :20482042
sw_np_tx_bytes  :31129450620
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dianose npu np6 synproxy-stats (NP6 SYN-proxied sessions and unacknowledged SYNs)
This command display information about NP6 syn-proxy sessions including the total number proxied sessions. As
well the Number of attacks, no ACK from client shows the total number of unacknowledge SYNs.

diagnose npu np6 synproxy-stats
DoS SYN-Proxy:
Number of proxied TCP connections : 39277346
Number of working proxied TCP connections : 182860
Number of retired TCP connections : 39094486
Number of attacks, no ACK from client : 208
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High availability

This document describes FortiGate HA, the FortiGate Clustering Protocol (FGCP), The FortiGate Session Life
Support Protocol (FGSP) and FortiGate VRRP.

This FortiOS Handbook chapter contains the following sections:

Solving the high availability problem describes the high availability problem and introduces the FortiOS solutions
described in this document (FGCP, VRRP, and standalone session synchronization).

An introduction to the FGCP introduces the FGCP clustering protocol and many of its features and terminology.

FGCP configuration examples and troubleshooting describes configuring HA clusters and contains HA clustering
configuration examples.

Virtual clusters describes configuring HA virtual clusters and contains virtual clustering configuration examples.

Full mesh HA describes configuring FortiGate Full mesh HA and contains a full mesh HA configuration example.

Operating clusters and virtual clusters describes how to operate a cluster and includes detailed information about
how various FortiGate systems operate differently in a cluster.

HA and failover protection describes in detail how FortiGate HA device failover, link failover, and session failover
work.

HA and load balancing describes how FGCPHA active-active load balancing works and how to configure it.

HA with FortiGate-VM and third-party products describes how FortiGates interact with third-party products.

VRRP high availability describes FortiOS support of the Virtual Router Redundancy Protocol (VRRP) and its use
for high availability.

FortiGate Session Life Support Protocol (FGSP) describes how to use the FGSP feature to support using external
routers or load balancers to distribute or load balance sessions between two peer FortiGates.

FortiOS 5.6 HA new features

New high availability features added to FortiOS 5.6.6:

l For FGSPHA, restoring a configuration is not synchronized, see Backing up and restoring the configuration of an
FGSP cluster on page 1997.

l FortiGate-6000 and FortiController-5000 support for VRRPHA on page 1989.

New high availability features added to FortiOS 5.6.4:

l FGSP configuration synchronization changes, see Synchronizing the configuration on page 1995.
l Changes to get system status ha command output, see Viewing cluster status from the CLI on page 1898.

New high availability features added to FortiOS 5.6.1:
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HA cluster Uptime on HA Status dashboard widget (412089)

The HA Status dashboard widget now displays how long the cluster has been operating (Uptime) and the time
since the last failover occurred (State Changed). You can hover over the State Changed time to see the event
that caused the state change.

You can also click on the HA Status dashboard widget to configure HA settings or to get a listing of the most
recent HA events recorded by the cluster.

FGSP with static (non-dialup) IPsec VPN tunnels and controlling IKE routing advertisement
(402295)

Until FortiOS 5.6.1, the FortiGate Session Life Support Protocol (FGSP) only supported IPsec tunnel
synchronization for dialup (or dynamic) IPsec VPN tunnels. FortiOS 5.6.1 now also supports IPsec tunnel
synchronization for static IPsec VPN tunnels. No special FGSP or IPsec VPN configuration is required. You can
configure static IPsec VPN tunnels normally and create a normal FGSP configuration.

An additional feature has been added to support some FGSP configurations that include IPsec VPNs. A new CLI
option allows you to control whether IKE routes are synchronized to all units in the FGSP cluster.

config system cluster-sync
edit 0

set slave-add-ike-routes {enable | disable}
end

Enable to synchronize IKE routes, disable if you do not need to synchronize IKE routes. Enabling routing
synchronization is optional but doing so increases synchronization overhead and bandwidth usage. If you have
problems with IPsec VPN tunnel synchronization you may want to enable synchronizing routes otherwise you
could leave it disabled to improve performance and save bandwidth.

VRRP support for synchronizing firewall VIPs and IP Pools (0397824)

FortiOS VRRPHA now supports failover of firewall VIPs and IP Pools when the status of a virtual router (VR)
changes. This feature introduces a new proxy ARP setting to map VIP and IP Pool address ranges to each VR's
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Virtual MAC (VMAC). After failover, the IP Ranges added to the new primary VR will be routed to the new primary
VR`s VMAC.

Use the following command to add a proxy ARP address range and a single IP address to a VR added to a
FortiGate`s port5 interface. The address range and single IP address should match the address range or single IP
for VIPs or IP Pools added to the port5 interface:

config system interface
edit port5

config vrrp
edit 1

config proxy-arp
edit 1

set ip 192.168.62.100-192.168.62.200
next
edit 2

set ip 192.168.62.225
end

New high availability features added to FortiOS 5.6.0:
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Solving the high availability problem

The basic high availability (HA) problem for TCP/IP networks and security gateways is keeping network traffic
flowing. Uninterrupted traffic flow is a critical component for online systems and media because critical business
processes quickly come to a halt when the network is down.

The security gateway is a crucial component of most networks since all traffic passes through it. A standalone
network security gateway is a single point of failure that is vulnerable to any number of software or hardware
problems that could compromise the device and bring all traffic on the network to a halt.

A common solution to the high availability problem is to eliminate the security gateway as single point of failure
by introducing redundancy. With two or more redundant security gateways, if one fails, the remaining one or more
gateways keep the traffic flowing. FortiOS provides six redundancy solutions: industry standard VRRP as well as
five proprietary solutions: FortiGate Cluster Protocol (FGCP) high availability, FortiGate Session Life Support
Protocol (FGSP) high availability, Session-Aware Load Balancing Clustering (SLBC), Enhanced Load Balanced
Clustering (ELBC) and Content Clustering.

You can combine more than one high availability solution into a single configuration. A
common reason for doing this could be to add VRRP to an FGCP or FGSP
configuration.

A strong and flexible High availability solution is required for many mission-critical firewall and security profile
applications. Each FortiOS high availability solution can be fine tuned to fit into many different network scenarios.

FortiGate Cluster Protocol (FGCP)
FGCPHA provides a solution for two key requirements of critical enterprise networking components: enhanced
reliability and increased performance. Enhanced reliability is achieved through device failover protection, link
failover protection and remote link failover protection. Also contributing to enhanced reliability is session failover
protection for most IPv4 and IPv6 sessions including TCP, UDP, ICMP, IPsec VPN, and NAT sessions. Increased
performance is achieved though active-active HA load balancing. Extended FGCP features include full mesh HA
and virtual clustering. You can also fine tune the performance of the FGCP to change how a cluster forms and
shares information among cluster units and how the cluster responds to failures.
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When configured onto your network an FGCP cluster appears to be a single FortiGate operating in NAT or
transparent mode and configuration synchronization allows you to configure a cluster in the same way as a
standalone FortiGate. If a failover occurs, the cluster recovers quickly and automatically and also sends
administrator notifications so that the problem that caused the failure can be corrected and any failed equipment
restored.

The FGCP is compatible with most network environments and most networking equipment. While initial
configuration is relatively quick and easy, a large number of tools and configuration options are available to fine
tune the cluster for most situations.

FortiGate Session Life Support Protocol (FGSP)
In a network that already includes load balancing (either with load balancers or routers) for traffic redundancy, two
identical FortiGates can be integrated into the load balancing configuration using the FortiGate Session Life
Support Protocol (FGSP). The external load balancers or routers can distribute sessions among the FortiGates
and the FGSP performs session synchronization of IPv4 and IPv6 TCP, SCTP, UDP, ICMP, expectation, and
NAT sessions to keep the session tables of both FortiGates synchronized.
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If one of the FortiGates fails, session failover occurs and active sessions fail over to the unit that is still operating.
This failover occurs without any loss of data. As well, the external load balancers or routers detect the failover and
re-distribute all sessions to the unit that is still operating.

Load balancing and session failover is done by external routers or load balancers and not by the FGSP. The
FortiGates just perform session synchronization which allows session failover to occur without packet loss.

The FGSP also includes configuration synchronization, allowing you to make configuration changes once for both
FortiGates instead of requiring duplicate configuration changes on each unit. However, settings that identify the
FortiGate to the network, for example, interface IP addresses and BGP neighbor settings, are not synchronized
so each FortiGate maintains its identity on the network. These settings must be configured separately for each
FortiGate.

In previous versions of FortiOS the FGSPwas called TCP session synchronization or
standalone session synchronization. However, the FGSP has been expanded to
include configuration synchronization and session synchronization of connectionless
sessions, expectation sessions, and NAT sessions.

VRRP high availability
FortiGates can function as primary (master) or backup Virtual Router Redundancy Protocol (VRRP) routers and
can be quickly and easily integrated into a network that has already deployed VRRP. A FortiGate can be
integrated into a VRRP group with any third-party VRRP devices and VRRP can provide redundancy between
multiple FortiGates. FortiOS supports VRRP version 2 and 3.
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In a VRRP configuration, when a FortiGate operating as the primary router fails, a backup router takes its place
and continues processing network traffic. If the backup router is a FortiGate, the network continues to benefit
from FortiOS security features. If the backup router is simply a router, after a failure traffic will continue to flow,
but FortiOS security features will be unavailable until the FortiGate is back on line. You can include different
FortiGate models in the same VRRP group.

FortiOS supports IPv4 and IPv6 VRRP between two or more FortiGates and between FortiGates and third-party
routers that support VRRP. Using VRRP, you can assign VRRP routers as primary or backup routers. The primary
router processes traffic and the backup routers monitor the primary router and can begin forwarding traffic if the
primary router fails. Similar to the FGCP, you can set up VRRP among multiple FortiGates to provide
redundancy. You can also create a VRRP group with a FortiGate and any routers that support VRRP.

In a VRRP configuration that includes one FortiGate and one router, normally the FortiGate would be the primary
router and all traffic would be processed by the FortiGate. If the FortiGate fails, all traffic switches to the router.
Network connectivity is maintained even though FortiGate security features are unavailable until the FortiGate is
back on line.

Session-Aware Load Balancing Clustering (SLBC)
Session-Aware Load Balancing Clusters consist of one or more FortiControllers acting as load balancers and two
or more FortiGate-5000s and operating as workers all installed in one or two FortiGate-5000 series chassis.

SLBC clusters load balance TCP and UDP sessions. As a session-aware load balancer, the FortiController
includes FortiASIC DP processors that maintain state information for all TCP and UDP sessions. The FortiASIC
DP processors are capable of directing any TCP or UDP session to any worker installed in the same chassis. This
session-awareness means that all TCP and UDP traffic being processed by a specific worker continues to be
processed by the same worker. Session-awareness also means that more complex networking features such as
network address translation (NAT), fragmented packets, complex UDP protocols, and complex protocols such as
SIP that use pinholes, can be load balanced by the cluster.

For more information about SLBC see the FortiController Session-Aware Load Balancing Guide.
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You cannot mix FGCP and SLBC clusters in the same FortiGate-5000 chassis.

Enhanced Load Balancing Clustering (ELBC)
ELBC uses FortiSwitch-5000 series load balancers to load balance traffic to FortiGate-5000 workers installed in a
FortiGate-5000 chassis. ELBC enhances scalability, reliability, and availability of mission critical IP-based
services, such as firewall, antivirus, web filtering, IPS, and so on. It also provides high availability by detecting
worker failures and automatically redistributing traffic to the workers that are still operating.

ELBC applies a load balancing algorithm against the source and/or destination address of packets to generate a
hash key value. Each worker has hash key values assigned to it. If the workers are running, then the traffic is
forwarded to the worker assigned to the hash key.The hash key value generated by the algorithm, the hash keys
accepted by the worker blades, and the blade the traffic is sent to are automatically calculated by the FortiSwitch.

For more information about ELBC see the ELBC Configuration Guide.

You cannot mix FGCP and ELBC clusters in the same FortiGate-5000 chassis.

Content clustering
A content cluster employs FortiSwitch-5203Bs or FortiController-5902Ds to load balance content sessions to
FortiGate-5000 workers. FortiSwitch-5203B content clusters consist of one or more FortiSwitch-5203Bs and
multiple FortiGate-5001Bs workers. FortiController-5902D content clusters consist of one or more FortiController-
5902Ds and multiple FortiGate-5001B workers.

Operating as a FortiGate in content cluster mode, a primary FortiSwitch-5203B or FortiController-5902D
performs routing, firewalling, stateful inspection, IPsec and SSL VPN encryption/decryption, and other FortiGate
functions. The FortiSwitch-5203B includes NP4 processors and the FortiController-5902Ds includes NP6
processors and an integrated switch fabrics that provides fastpath acceleration by offloading communication
sessions from the FortiGate CPU.

Using content cluster weighted load balancing, the FortiSwitch-5203Bs or FortiController-5902Ds distribute
sessions that require content processing to the workers over the FortiGate-5000 chassis fabric backplane.
Content processing sessions include proxy and flow-based security profile functions such as virus scanning,
intrusion protection, application control, IPS, web filtering, email filtering, and VoIP. Load balancing is offloaded
to the NP4 or NP6 processors resulting in improved load balancing performance. In some networks, the NP4 or
NP6 processors also allow you to configure the efficiently load balance TCP and UDP sessions.

Content cluster mode is similar to active-active HAwhere the FortiSwitch-5203B or FortiController-5902D
operates as the primary unit and load balances security profile sessions to the workers installed in the chassis
using weighted load balancing. In this configuration, the HAmode is active-active, the HA load balancing
schedule is weight-round-robin and load-balance-all is disabled. You can adjust the HAweighted load balancing
weights to change how sessions are load balanced.

You can add a second FortiSwitch-5203B or FortiController-5902D to a content cluster as a backup. The primary
FortiSwitch-5203B or FortiController-5902D can load balance sessions to the backup FortiSwitch-5203B or

1730 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 15 - High Availability Solving the high availability problem

FortiController-5902D as well as the workers. You can control how many sessions are processed by the backup
FortiSwitch-5203B or FortiController-5902D by configuring the HA load balancing weights. You can also configure
the content cluster to operate the backup FortiSwitch-5203B or FortiController-5902D in standby mode. In this
mode the backup FortiSwitch-5203B or FortiController-5902D does not process any sessions but is just there to
take over content clustering if the primary unit fails.

Once the content cluster has been established and all FortiControllers and workers have joined the cluster, you
can configure the cluster from the FortiSwitch-5203B or FortiController-5902D GUI or CLI. All configuration
changes made to the primary unit are automatically synchronized to all cluster units.

FortiSwitch-5203B or FortiController-5902D firmware upgrades are done from the primary FortiSwitch-5203B or
FortiController-5902D GUI or CLI. Worker firmware upgrades are done from the FortiSwitch-5203B or
FortiController-5902D CLI where a single firmware image is uploaded once and synchronized to all of the
workers.
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A FortiGate HA cluster consists of two to four FortiGates configured for HA operation. Each FortiGate in a cluster
is called a cluster unit. All cluster units must be the same FortiGate model with the same FortiOS firmware build
installed. All cluster units must also have the same hardware configuration (for example, the same number of
hard disks and so on) and be running in the same operating mode (NAT mode or transparent mode).

You can create an FGCP cluster of up to four FortiGates.

In addition the cluster units must be able to communicate with each other through their heartbeat interfaces. This
heartbeat communication is required for the cluster to be created and to continue operating. Without it, the
cluster acts like a collection of standalone FortiGates.

On startup, after configuring the cluster units with the same HA configuration and connecting their heartbeat
interfaces, the cluster units use the FortiGate Clustering Protocol (FGCP) to find other FortiGates configured for
HA operation and to negotiate to create a cluster. During cluster operation, the FGCP shares communication and
synchronization information among the cluster units over the heartbeat interface link. This communication and
synchronization is called the FGCP heartbeat or the HA heartbeat. Often, this is shortened to just heartbeat.

The cluster uses the FGCP to select the primary unit, and to provide device, link and session failover. The FGCP
also manages the two HAmodes; active-passive (failover HA) and active-active (load balancing HA).

About the FGCP
FortiGate HA is implemented by configuring two or more FortiGates to operate as an HA cluster. To the network,
the HA cluster appears to function as a single FortiGate, processing network traffic and providing normal security
services such as firewalling, security profile services, Security Fabric services, and VPN services.
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HA cluster installed between an internal network and the Internet

Inside the cluster the individual FortiGates are called cluster units. These cluster units share state and
configuration information. If one cluster unit fails, the other units in the cluster automatically replace that unit,
taking over the work that the failed unit was doing. After the failure, the cluster continues to process network
traffic and provide normal FortiGate services with virtually no interruption.

Every FortiGate cluster contains one primary unit (also called the master unit) and one or more subordinate units
(also called slave or backup units). The primary unit controls how the cluster operates. The role that the
subordinate units play depends on the mode in which the cluster operates: (Active-Passive (AP) or Active-Active
(AA).

The ability of an HA cluster to continue providing firewall services after a failure is called failover. FGCP failover
means that your network does not have to rely on one FortiGate to continue functioning. You can install
additional units and form an HA cluster.

A second HA feature, called active-active load balancing, can be used to increase performance. An active-active
cluster of FortiGates can increase overall network performance by sharing the load of processing network traffic
and providing security services. The cluster appears to your network to be a single device, adding increased
performance without changing your network configuration.

Virtual clustering extends HA features to provide failover protection and load balancing for Virtual Domains
(VDOMs). See Virtual clusters on page 1850.

FortiGate models that support redundant interfaces can be configured to support full mesh HA. Full mesh HA is a
method of reducing the number of single points of failure on a network that includes an HA cluster. For details
about full mesh HA, see Full mesh HA on page 1860.
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FGCP failover protection

The FGCP provides IP/MAC takeover failover protection by assigning virtual MAC addresses to the primary
cluster unit and then sending gratuitous ARP packets from the primary unit interfaces to reprogram the network.

Failover times can be less than a second under optimal conditions. You can fine tune failover performance for
your network by adjusting cluster status checking timers, routing table update timers, and wait timers.

An HA cluster fails over if the primary unit fails (a device failure) or experiences a link failure. The cluster can
detect link failures for connections to the primary unit using port monitoring and for connections between
downstream network components using remote IPmonitoring. To compensate for a link failover, the cluster
maintains active links to keep traffic flowing between high-priority networks. Port and remote IPmonitoring can
be fine tuned without disrupting cluster operation.

Session failover

FGCP session failover maintains TCP, SIP and IPsec VPN sessions after a failure. You can also configure
session failover to maintain UDP and ICMP sessions. Session failover does not failover SSL VPN sessions.
Session failover may not be required for all networks because many TCP/IP, UDP, and ICMP protocols can
resume sessions on their own. Supporting session failover adds extra overhead to cluster operations and can be
disabled to improve cluster performance if it is not required.

Load balancing

Active-active HA load balances resource-intensive security profile features such as virus scanning, web filtering,
intrusion protection, application control, email filtering and data leak prevention operations among all cluster
units to provide better performance than a standalone FortiGate. If network traffic consists of mainly TCP
sessions, the FGCP can also load balance all TCP sessions to improve TCP performance in some network
configurations. On some FortiGate models you can also load balance UDP sessions. NP4 and NP6 offloading can
accelerate HA load balancing (especially TCP and UDP load balancing). HA load balancing schedules can be
adjusted to optimize performance for the traffic mix on your network. Weighted load balancing can be used to
control the relative amount of sessions processed by each cluster unit.

Virtual clustering

Virtual clustering is an extension of the FGCP for a cluster of 2 FortiGates operating with multiple VDOMS
enabled. Not only does virtual clustering provide failover protection for a multiple VDOM configuration, but a
virtual cluster can load balance traffic between the cluster units. Load balancing with virtual clustering is quite
efficient and load balances all traffic. It is possible to fine tune virtual clustering load balancing in real time to
actively optimize load sharing between the cluster units without affecting the smooth operation of the cluster.

Full mesh HA

High availability improves the reliability of a network by replacing a single point of failure (a single FortiGate) with
a cluster that can maintain network traffic if one of the cluster units fails. However, in a normal FGCP cluster,
single points of failure remain. Full mesh HA removes these single points of failure by allowing you to connect
redundant switches to each cluster interface. Full mesh HA is achieved by configuring 802.3ad aggregate or
redundant interfaces on the FortiGate and connecting redundant switches to these interfaces. Configuration is a
relatively simple extension of the normal aggregate/redundant interface and HA configurations.

Cluster management

FortiOS HA provides a wide range of cluster management features:
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l Automatic continuous configuration synchronization. You can get a cluster up and running almost as quickly as a
standalone FortiGate by performing a few basic steps to configure HA settings and minimal network settings on
each cluster unit. When the cluster is operating you can configure FortiGate features such as firewalling, content
inspection, and VPN in the same way as for a standalone FortiGate. All configuration changes (even complex
changes such as switching to multiple VDOM mode or from NAT to transparent mode) are synchronized among all
cluster units.

l Firmware upgrades/downgrades. Upgrading or downgrading cluster firmware is similar to upgrading or downgrading
standalone FortiGate firmware. The Firmware is uploaded once to the primary unit and the cluster automatically
upgrades or downgrades all cluster units in one operation with minimal or no service interruption.

l Individual cluster unit management. In some cases you may want to manage individual cluster units. You can do so
from cluster CLI by navigating to each cluster unit. You can also use the reserved management interface feature to
give each cluster unit its own IP address and default route. You can use the reserved management interfaces and
IP addresses to connect to the GUI and CLI of each cluster unit and configure an SNMP server to poll each cluster
unit.

l Removing and adding cluster units. In one simple step any unit (even the primary unit) can be removed from a
cluster and given a new IP address. The cluster keeps operating as it was; the transition happening without
interrupting cluster operation. A new unit can also be added to an operating cluster without disrupting network
traffic. All you have to do is connect the new unit and change its HA configuration to match the cluster’s. The cluster
automatically finds and adds the unit and synchronizes its configuration with the cluster.

l Debug and diagnose commands. An extensive range of debug and diagnose commands can be used to report on
HA operation and find and fix problems.

l Logging and reporting. All cluster units can be configured to record all log messages. These message can be stored
on the individual cluster units or sent to a FortiAnalyzer unit. You can view all cluster unit log messages by logging
into any cluster unit.

l FortiManager support. FortiManager understands FortiOS HA and automatically recognizes when you add a
FortiOS cluster to the FortiManager configuration.

The FGCP uses a combination of incremental and periodic synchronization to make sure that the configuration of
all cluster units is synchronized to that of the primary unit. This means that in most cases you only have to make a
configuration change once to have it synchronized to all cluster units.

Synchronizing the configuration (and settings that are not synchronized)
The FGCP uses a combination of incremental and periodic synchronization to make sure that the configuration of
all cluster units is synchronized to that of the primary unit. This means that in most cases you only have to make a
configuration change once to have it synchronized to all cluster units. This includes special configuration settings
that include extra information (for example, 3rd party certificates, replacement message text files and graphics
and so on).

Some configuration settings are not synchronized to support some aspects of FortiGate operation. The following
settings are not synchronized among cluster units:

l The FortiGate host name. Allows you to identify cluster units.
l The GUI Dashboard configuration. After a failover you may have to re-configure dashboard widgets.
l HA override.
l HA device priority.
l Virtual cluster 1 and Virtual cluster 2 device priorities.
l The HA priority (ha-priority) setting for a ping server or dead gateway detection configuration.
l The system interface settings of the FortiGate interface that becomes the HA reserved management interface.
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l The default route for the reserved management interface, set using the ha-mgmt-interface-gateway option
of the config system ha command.

l The dynamic weighted load balancing thresholds and high and low watermarks.
l OSPF summary-addresses settings.

In addition licenses are not synchronized since each FortiGate must be licensed separately. This includes
FortiCloud activation and FortiClient licensing, and entering a license key if you purchased more than 10 Virtual
Domains (VDOMS).

Preparing the FortiGates before setting up an FGCP cluster
Before creating an FGCP cluster you should complete the following setup on each FortiGate.

DHCP and PPPoE

Make sure your FortiGate interfaces are configured with static IP addresses. If any interface gets its address
using DHCP or PPPoE you should temporarily switch it to a static address and enable DHCP or PPPoE after the
cluster has been established.

Firmware version

Make sure the FortiGates are running the same FortiOS firmware version.

About HA and licensing

All of the FortiGates in a cluster must have the same level of licensing. This includes licensing for FortiCare
Support, IPS, AntiVirus, Web Filtering, Mobile Malware, FortiClient, FortiCloud, and additional virtual domains
(VDOMs).

If one of the FortiGates in a cluster has a lower level of licensing than other FortiGates in the cluster, then all of
the FortiGates in the cluster will revert to that lower licensing level. For example, if you only purchase FortiGuard
Web Filtering for one of the FortiGates in a cluster, when the cluster is operating, none of the cluster units will
support FortiGuard Web Filtering.

An exception is FortiToken licensing. FortiToken activations are completed one FortiGate unit and synchronized
to all of the FortiGates in the cluster.

FortiOS Carrier license

If the FortiGates in the cluster will be running FortiOS Carrier, apply the FortiOS Carrier license before
configuring the cluster (and before applying other licenses). Applying the FortiOS Carrier license sets the
configuration to factory defaults, requiring you to repeat steps performed before applying the license. All
FortiGates in the cluster must be licensed for FortiOS Carrier.

Support contracts and FortiGuard, FortiCloud, FortiClient, VDOMs licensing

Register and apply these licenses to each FortiGate. This includes FortiCloud activation and FortiClient licensing,
and entering a license key if you purchased more than 10 Virtual Domains (VDOMS). All FortiGates in the cluster
must have the same level of licensing for FortiGuard, FortiCloud, FortiClient and VDOMs.
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FortiToken licenses

You only need one set of FortiToken licenses for the HA cluster and you only need to activate each token once.
Normally you would activate your tokens on the primary unit and this configuration and the seed information will
be synchronized to all cluster members so all tokens will then be activated for all cluster members.

If you have added FortiToken licenses and activated FortiTokens on a standalone FortiGate unit before
configuring HA, the licenses and the FortiToken activations will usually be synchronized to all cluster units after
forming a cluster. To make sure this goes smoothly you can make sure the FortiGate that you have added the
licenses to becomes the primary unit when setting up the cluster as described in How to set up FGCP clustering
(recommended steps) on page 1771.

Certificates

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed third-party certificates are synchronized to the backup FortiGate.

Configuring FortiGates for FGCP HA operation
Each FortiGate in the cluster must have the same HA configuration. Once the cluster is connected, you can
configure it in the same way as you would configure a standalone FortiGate. The following example sets the HA
mode to active-passive and the HA password to HA_pass.

Make sure your FortiGate interfaces are configured with static IP addresses. If any
interface gets its address using DHCP or PPPoE you should temporarily switch it to a
static address and enable DHCP or PPPoE after the cluster has been established.

Make sure both FortiGates are running the same FortiOS firmware version. Register and apply licenses to both
FortiGates before adding them to the cluster. This includes licensing for FortiCare Support, IPS, AntiVirus, Web
Filtering, Mobile Malware, FortiClient, FortiCloud, and additional virtual domains (VDOMs). All FortiGates in the
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cluster must have the same level of licensing for FortiGuard, FortiCloud, FortiClient, and VDOMs. FortiToken
licenses can be added at any time because they are synchronized to all cluster members.

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed, third-party certificates are synchronized to the backup FortiGate.

To configure a FortiGate for HA operation - GUI

1. Power on the FortiGate to be configured.
2. Log into the GUI.
3. Locate the System Information Dashboard widget. Click on the System Information dashboard widget and select

Configure settings in System > Settings.
4. Enter a new Host Name for this FortiGate.

Changing the host name makes it easier to identify individual cluster units when the cluster is operating.
5. Go to System > HA and change the following settings:

Mode Active-Passive

Group Name Example_cluster

Password HA_pass

The password must be the same for all FortiGates in the cluster.

You can accept the default configuration for the remaining HA options and change them later, once
the cluster is operating.

6. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose connectivity
with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address of the FortiGate
interfaces. To be able to reconnect sooner, you can update the ARP table of your management PC by deleting the
ARP table entry for the FortiGate (or just deleting all ARP table entries). You may be able to delete the ARP table
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of your management PC from a command prompt using a command similar to arp -d.
7. Power off the FortiGate.
8. Repeat this procedure for all of the FortiGates in the cluster.

Once all of the units are configured, continue by connecting the FortiGate HA cluster below.

To configure a FortiGate for HA operation - CLI

1. Power on the FortiGate to be configured.
2. Log into the CLI.
3. Enter the following command to change the FortiGate host name.

config system global
set hostname Example1_host

end

Changing the host name makes it easier to identify individual cluster units when the cluster is
operating.

4. Enter the following command to enable HA:
config system ha

set mode active-passive
set group-name Example_cluster
set password HA_pass

end

You can accept the default configuration for the remaining HA options and change them later, once
the cluster is operating.

The FortiGate negotiates to establish an HA cluster. You may temporarily lose connectivity with the
FortiGate as the HA cluster negotiates and because the FGCP changes the MAC address of the
FortiGate interfaces. To be able to reconnect sooner, you can update the ARP table of your
management PC by deleting the ARP table entry for the FortiGate (or just deleting all arp table
entries). You may be able to delete the arp table of your management PC from a command prompt
using a command similar to arp -d.

5. Power off the FortiGate.
6. Repeat this procedure for all of the FortiGates in the cluster.

Once all of the units are configured, continue with connecting the FortiGate HA cluster.

Connecting a FortiGate HA cluster

Use the following procedure to connect a cluster. Connect the cluster units to each other and to your network. You
must connect all matching interfaces in the cluster to the same switch, then connect these interfaces to their
networks using the same switch.

Although you can use hubs, Fortinet recommends using switches for all cluster connections for the best
performance.

Connecting an HA cluster to your network temporarily interrupts communications on the network because new
physical connections are being made to route traffic through the cluster. Also, starting the cluster interrupts
network traffic until the individual cluster units are functioning and the cluster completes negotiation. Cluster
negotiation is automatic and normally takes just a few seconds. During system startup and negotiation all
network traffic is dropped.

This section describes how to connect the cluster shown below, which consists of two FortiGate-100D units to be
connected between the Internet and a head office internal network. The wan1 interfaces of the FortiGate connect
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the cluster to the Internet and the internal interfaces connect the cluster to the internal network. The ha1 and ha2
interfaces are used for redundant HA heartbeat links.

Example cluster connections

To connect a FortiGate HA cluster

1. Connect the WAN1 interfaces of each cluster unit to a switch connected to the Internet.
2. Connect the Port1 interfaces of each cluster unit to a switch connected to the internal network.
3. Connect the HA1 interfaces of the cluster units together. You can use a crossover Ethernet cable or a regular

Ethernet cable. (You can also connect the interfaces using Ethernet cables and a switch.)
4. Connect the HA2 interfaces of the cluster units together. You can use a crossover Ethernet cable or a regular

Ethernet cable. (You can also connect the interfaces using Ethernet cables and a switch.)
5. Power on both of the FortiGates.

As the cluster units start, they negotiate to choose the primary unit and the subordinate unit. This
negotiation occurs with no user intervention and normally just takes a few seconds.

At least one heartbeat interface should be connected together for the cluster to operate.

Do not use a switch port for the HA heartbeat traffic. This configuration is not supported.

You could use one switch to connect all four heartbeat interfaces. However, this is not recommended
because if the switch fails both heartbeat interfaces will become disconnected.

6. You can now configure the cluster as if it is a single FortiGate.

Verifying the cluster status from the HA Status dashboard widget

The HA Status dashboard widget shows the mode and group names of the cluster, the status of the cluster units
and their hostnames, the cluster uptime and the last time the cluster state changed. A state change can indicate
the cluster first forming or one of the cluster units changing its role in the cluster.
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The HA Status Dashboard widget also shows if the cluster units are synchronized. Mouse over each FortiGate in
the cluster to verify that they both have the same checksum.

From the HA Status widget you can also select Show HA Historical Events to see the most recent HA system
status messages.
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Active-passive and active-active HA
The first decision to make when configuring FortiGate HA is whether to choose active-passive or active-active HA
mode. To configure the HAmode, go to System > HA and set Mode to Active-Passive orActive-Active.

From the CLI enter the following command to set the HAmode to active-passive:

config system ha
set mode a-p

end

To form a cluster, all cluster units must be set to the same mode. You can also change the mode after the cluster
is up and running. Changing the mode of a functioning cluster causes a slight delay while the cluster renegotiates
to operate in the new mode and possibly select a new primary unit.

Active-passive HA (failover protection)

An active-passive (A-P) HA cluster provides hot standby failover protection. An active-passive cluster consists of a
primary unit that processes communication sessions, and one or more subordinate units. The subordinate units
are connected to the network and to the primary unit but do not process communication sessions. Instead, the
subordinate units run in a standby state. In this standby state, the configuration of the subordinate units is
synchronized with the configuration of the primary unit and the subordinate units monitor the status of the primary
unit.

Active-passive HA provides transparent device failover among cluster units. If a cluster unit fails, another
immediately take its place.

Active-passive HA also provides transparent link failover among cluster units. If a cluster unit interface fails or is
disconnected, this cluster unit updates the link state database and the cluster negotiates and may select a new
primary unit.

If session failover (also called session pickup) is enabled, active-passive HA provides session failover for some
communication sessions.

The following example shows how to configure a FortiGate for active-passive HA operation. You would enter the
exact same commands on every FortiGate in the cluster.

config system ha
set mode a-p
set group-name myname
set password HApass

end

Active-active HA (load balancing and failover protection)

By default, active-active HA load balancing distributes proxy-based security profile processing to all cluster units.
Proxy-based security profile processing is CPU and memory-intensive, so FGCP load balancing may result in
higher throughput because resource-intensive processing is distributed among all cluster units.

Normally, sessions accepted by policies that don’t include security profiles are not load balanced and are
processed by the primary unit. You can configure active-active HA to load balance additional sessions.

An active-active HA cluster consists of a primary unit that receives all communication sessions and load balances
them among the primary unit and all of the subordinate units. In an active-active cluster the subordinate units are
also considered active since they also process content processing sessions. In all other ways active-active HA
operates the same as active-passive HA.
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The following example shows how to configure a FortiGate for active-active HA operation. You would enter the
exact same commands on every FortiGate in the cluster.

config system ha
set mode a-a
set group-name myname
set password HApass

end

Identifying the cluster and cluster units
You can use the cluster group name, group id, and password to identify a cluster and distinguish one cluster from
another. If you have more than one cluster on the same network, each cluster must have a different group name,
group id, and password.

Group name

Use the group name to identify the cluster. The maximum length of the group name is 32 characters. The group
name must be the same for all cluster units before the cluster units can form a cluster. After a cluster is operating,
you can change the group name. The group name change is synchronized to all cluster units. The group name
appears on the HA Status dashboard widget.

To add or change the group name from the GUI go to System > HA and change theGroup name.

Enter the following CLI command to change the group name to Cluster_name:

config system ha
set group-name Cluster_name

end

Password

Use the password to identify the cluster. You should always change the password when configuring a cluster. The
password must be the same for all FortiGates before they can form a cluster. When the cluster is operating you
can change the password, if required. Two clusters on the same network cannot have the same password.

To change the password from the GUI go to System > HA and change the Password.

Enter the following CLI command to change the password to ha_pwd:

config system ha
set password ha_pwd

end

Group ID

Similar to the group name, the group ID is also identifies the cluster. In most cases you do not have to change the
group ID. However, you should change the group ID if you have more than one cluster on the same network. All
members of the HA cluster must have the same group ID. The group ID is a number from 0 to 255.

Changing the group ID changes the cluster virtual MAC address. If two clusters on the same network have the
same group ID you may encounter MAC address conflicts.

Enter the following CLI command to change the group ID to 10:

config system ha
set group-id 10

end
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Device failover, link failover, and session failover
The FGCP provides transparent device and link failover. You can also enable session pickup to provide session
failover. A failover can be caused by a hardware failure, a software failure, or something as simple as a network
cable being disconnected causing a link failover. When a failover occurs, the cluster detects and recognizes the
failure and takes steps to respond so that the network can continue to operate without interruption. The internal
operation of the cluster changes, but network components outside of the cluster notice little or no change.

If a failover occurs, the cluster also records log messages about the event and can be configured to send log
messages to a syslog server and to a FortiAnalyzer unit. The cluster can also send SNMP traps and alert email
messages. These alerts can notify network administrators of the failover and may contain information that the
network administrators can use to find and fix the problem that caused the failure.

For a complete description of device failover, link failover, and session failover, how clusters support these types
of failover, and how FortiGate HA clusters compensate for a failure to maintain network traffic flow see HA and
failover protection on page 1909.

Primary unit selection
Once FortiGates recognize that they can form a cluster, the cluster units negotiate to select a primary unit.
Primary unit selection occurs automatically based on the criteria shown below. After the cluster selects the
primary unit, all of the remaining cluster units become subordinate units.

Negotiation and primary unit selection also takes place if a primary unit fails (device failover) or if a monitored
interface fails or is disconnected (link failover). During a device or link failover, the cluster renegotiates to select a
new primary unit also using the criteria shown below.
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For many basic HA configurations primary unit selection simply selects the cluster unit with the highest serial
number to become the primary unit. A basic HA configuration involves setting the HAmode to active-passive or
active-active and configuring the cluster group name and password. Using this configuration, the cluster unit with
the highest serial number becomes the primary unit because primary unit selection disregards connected
monitored interfaces (because interface monitoring is not configured), the age of the cluster units would usually
always be the same, and all units would have the same device priority.

Using the serial number is a convenient way to differentiate cluster units; so basing primary unit selection on the
serial number is predictable and easy to understand and interpret. Also the cluster unit with the highest serial
number would usually be the newest FortiGate with the most recent hardware version. In many cases you may
not need active control over primary unit selection, so basic primary unit selection based on serial number is
sufficient.

In some situations you may want have control over which cluster unit becomes the primary unit. You can control
primary unit selection by setting the device priority of one cluster unit to be higher than the device priority of all
other cluster units. If you change one or more device priorities, during negotiation, the cluster unit with the
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highest device priority becomes the primary unit. As shown above, the FGCP selects the primary unit based on
device priority before serial number. For more information about how to use device priorities, see Primary unit
selection and device priority on page 1750.

The only other way that you can influence primary unit selection is by configuring interface monitoring (also called
port monitoring). Using interface monitoring you can make sure that cluster units with failed or disconnected
monitored interfaces cannot become the primary unit. See Primary unit selection and monitored interfaces on
page 1747.

Finally, the age of a cluster unit is determined by a number of operating factors. Normally the age of all cluster
units is the same so normally age has no effect on primary unit selection. Age does affect primary unit selection
after a monitored interface failure. For more information about age, see Primary unit selection and age on page
1747.

Viewing how the primary unit was selected

You can use the get system ha status command to see how the primary unit was selected. The output of
this command contains a section called Master selected using that shows a history of how the primary
unit was selected. For example, when a cluster first forms this part of the command output could have one line
showing that the primary unit is the cluster unit with the highest uptime.

get system ha status
.
.
.
Master selected using:

<2016/10/12 11:13:23> FG-5KD3914800344 is selected as the master because it
has the largest value of uptime.
.
.
.

Over time more messages could be added as the cluster negotiates to choose a new primary unit on different
occasions. The command output below shows the cluster negotiated four times over a few days.

get system ha status
.
.
.
Master selected using:

<2016/10/16 11:36:07> FG-5KD3914800344 is selected as the master because it
has the largest value of uptime.

<2016/10/15 11:24:11> FG-5KD3914800284 is selected as the master because it
has the largest value of override priority.

<2016/10/13 11:15:13> FG-5KD3914800344 is selected as the master because it
has the largest value of uptime.

<2016/10/11 11:13:23> FG-5KD3914800344 is selected as the master because it
has the largest value of uptime.
.
.
.
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Primary unit selection and monitored interfaces

If you have configured interface monitoring the cluster unit with the highest number of monitored interfaces that
are connected to networks becomes the primary unit. Put another way, the cluster unit with the highest number of
failed or disconnected monitored interfaces cannot become the primary unit.

Normally, when a cluster starts up, all monitored interfaces of all cluster units are connected and functioning
normally. So monitored interfaces do not usually affect primary unit selection when the cluster first starts.

A cluster always renegotiates when a monitored interface fails or is disconnected (called link failover). A cluster
also always renegotiates when a failed or disconnected monitored interface is restored.

If a primary unit monitored interface fails or is disconnected, the cluster renegotiates and if this is the only failed
or disconnected monitored interface the cluster selects a new primary unit.

If a subordinate unit monitored interface fails or is disconnected, the cluster also renegotiates but will not
necessarily select a new primary unit. However, the subordinate unit with the failed or disconnected monitored
interface cannot become the primary unit.

Multiple monitored interfaces can fail or become disconnected on more than one cluster unit. Each time a
monitored interface is disconnected or fails, the cluster negotiates to select the cluster unit with the most
connected and operating monitored interfaces to become the primary unit. In fact, the intent of the link failover
feature is just this, to make sure that the primary unit is always the cluster unit with the most connected and
operating monitored interfaces.

Primary unit selection and age

The cluster unit with the highest age value becomes the primary unit. The age of a cluster unit is the amount of
time since a monitored interface failed or is disconnected. Age is also reset when a cluster unit starts (boots up).
So, when all cluster units start up at about the same time, they all have the same age. Age does not affect
primary unit selection when all cluster units start up at the same time. Age also takes precedence over priority for
primary unit selection.

If a link failure of a monitored interface occurs, the age value for the cluster unit that experiences the link failure is
reset. So, the cluster unit that experienced the link failure also has a lower age value than the other cluster units.
This reduced age does not effect primary unit selection because the number of link failures takes precedence
over the age.

If the failed monitored interface is restored the cluster unit that had the failed monitored interface cannot become
the primary unit because its age is still lower than the age of the other cluster units.

In most cases, the way that age is handled by the cluster reduces the number of times the cluster selects a new
primary unit, which results in a more stable cluster since selecting a new primary unit has the potential to disrupt
traffic.

Cluster age difference margin (grace period)

In any cluster, some of the cluster units may take longer to start up than others. This startup time difference can
happen as a result of a number of issues and does not affect the normal operation of the cluster. To make sure
that cluster units that start slower can still become primary units, by default the FGCP ignores age differences of
up to 5 minutes (300 seconds).

In most cases, during normal operation this age difference margin or grace period helps clusters function as
expected. However, the age difference margin can result in some unexpected behavior in some cases:
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l During a cluster firmware upgrade with uninterruptible-upgrade enabled (the default configuration) the
cluster should not select a new primary unit after the firmware of all cluster units has been updated. But since the
age difference of the cluster units is most likely less than 300 seconds, age is not used to affect primary unit
selection and the cluster may select a new primary unit.

l During failover testing where cluster units are failed over repeatedly the age difference between the cluster units will
most likely be less than 5 minutes. During normal operation, if a failover occurs, when the failed unit rejoins the
cluster its age will be very different from the age of the still operating cluster units so the cluster will not select a new
primary unit. However, if a unit fails and is restored in a very short time the age difference may be less than 5
minutes. As a result the cluster may select a new primary unit during some failover testing scenarios.

Changing the cluster age difference margin

You can change the cluster age difference margin using the following command:

config system ha
set ha-uptime-diff-margin 60

end

This command sets the cluster age difference margin to 60 seconds (1 minute). The age difference margin range
1 to 65535 seconds. The default is 300 seconds.

You may want to reduce the margin if during failover testing you don’t want to wait the default age difference
margin of 5 minutes. You may also want to reduce the margin to allow uninterruptible upgrades to work. See
Operating clusters and virtual clusters on page 1874.

You may want to increase the age margin if cluster unit startup time differences are larger than 5 minutes.

Displaying cluster unit age differences

You can use the CLI command diagnose sys ha dump-by group to display the age difference of the
units in a cluster. This command also displays information about a number of HA-related parameters for each
cluster unit.

For example, consider a cluster of two FortiGate-600D units. Entering the diagnose sys ha dump-by
group command from the primary unit CLI displays information similar to the following:

diagnose sys ha dump-by group
HA information.

group-id=0, group-name='External-HA-Cluster'

gmember_nr=2
'FGT6HD3916800525': ha_ip_idx=1, hb_packet_version=6, last_hb_jiffies=52097155,
linkfails=11, weight/o=0/0

hbdev_nr=2: port3(mac=906c..70, last_hb_jiffies=52097155, hb_lost=0), port4(mac-
c=906c..71, last_hb_jiffies=52097155, hb_lost=0),
'FGT6HD3916801195': ha_ip_idx=0, hb_packet_version=6, last_hb_jiffies=0, link-
fails=0, weight/o=0/0

vcluster_nr=1
vcluster_0: start_time=1507754642(2017-10-11 13:44:02), state/o/chg_time=2(work)/2
(work)/1507754644(2017-10-11 13:44:04)

'FGT6HD3916801955': ha_prio/o=1/1, link_failure=0(old=0), pingsvr_failure=0, flag-
g=0x00000000, uptime/reset_cnt=0/1

'FGT6HD3916800525': ha_prio/o=0/0, link_failure=0(old=0), pingsvr_failure=0, flag-
g=0x00000001, uptime/reset_cnt=189/0
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The last two lines of the output display status information about each cluster unit including the uptime. The
uptime is the age difference in seconds between the two units in the cluster.

In the example, the age of the subordinate unit is 189 seconds more than the age of the primary unit. The age
difference is less than 5 minutes (less than 300 seconds) so age has no affect on primary unit selection. The
cluster selected the unit with the highest serial number to be the primary unit.

If port1 (the monitored interface) of the primary unit is disconnected, the cluster renegotiates and the former
subordinate unit becomes the primary unit. When you log into the new primary unit CLI and enter diagnose
sys ha dump-by group you could get results similar to the following:

diagnose sys ha dump-by group
HA information.

group-id=0, group-name='External-HA-Cluster'

gmember_nr=2
'FGT6HD3916800525': ha_ip_idx=1, hb_packet_version=6, last_hb_jiffies=52097155,
linkfails=11, weight/o=0/0

hbdev_nr=2: port3(mac=906c..70, last_hb_jiffies=52097155, hb_lost=0), port4(mac-
c=906c..71, last_hb_jiffies=52097155, hb_lost=0),
'FGT6HD3916801195': ha_ip_idx=0, hb_packet_version=6, last_hb_jiffies=0, link-
fails=0, weight/o=0/0

vcluster_nr=1
vcluster_0: start_time=1507754642(2017-10-11 13:44:02), state/o/chg_time=2(work)/2
(work)/1507754644(2017-10-11 13:44:04)

'FGT6HD3916800525': ha_prio/o=1/1, link_failure=0(old=0), pingsvr_failure=0, flag-
g=0x00000000, uptime/reset_cnt=0/1

'FGT6HD3916801955': ha_prio/o=0/0, link_failure=0(old=0), pingsvr_failure=0, flag-
g=0x00000001, uptime/reset_cnt=236/0

The command results show that the age of the new primary unit is 236 seconds higher than the age of the new
subordinate unit.

If port1 of the former primary unit is reconnected the cluster will once again make this the primary unit because
the age difference will still be less than 300 seconds. When you log into the primary unit CLI and enter
diagnose sys ha dump-by group you get results similar to the following:

diagnose sys ha dump-by group
HA information.

group-id=0, group-name='External-HA-Cluster'

gmember_nr=2
'FGT6HD3916800525': ha_ip_idx=1, hb_packet_version=6, last_hb_jiffies=52097155,
linkfails=11, weight/o=0/0

hbdev_nr=2: port3(mac=906c..70, last_hb_jiffies=52097155, hb_lost=0), port4(mac-
c=906c..71, last_hb_jiffies=52097155, hb_lost=0),
'FGT6HD3916801195': ha_ip_idx=0, hb_packet_version=6, last_hb_jiffies=0, link-
fails=0, weight/o=0/0

vcluster_nr=1
vcluster_0: start_time=1507754642(2017-10-11 13:44:02), state/o/chg_time=2(work)/2
(work)/1507754644(2017-10-11 13:44:04)

'FGT6HD3916800525': ha_prio/o=1/1, link_failure=0(old=0), pingsvr_failure=0, flag-
g=0x00000000, uptime/reset_cnt=0/1
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'FGT6HD3916801955': ha_prio/o=0/0, link_failure=0(old=0), pingsvr_failure=0, flag-
g=0x00000001, uptime/reset_cnt=-236/0

Resetting the age of all cluster units

In some cases, age differences among cluster units can result in the wrong cluster unit or the wrong virtual cluster
becoming the primary unit. For example, if a cluster unit set to a high priority reboots, that unit will have a lower
age than other cluster units when it rejoins the cluster. Since age takes precedence over priority, the priority of
this cluster unit will not be a factor in primary unit selection.

This problem also affects virtual cluster VDOM partitioning in a similar way. After a reboot of one of the units in a
virtual cluster configuration, traffic for all VDOMs could continue to be processed by the cluster unit that did not
reboot. This can happen because the age of both virtual clusters on the unit that did not reboot is greater that the
age of both virtual clusters on the unit that rebooted.

One way to resolve this issue is to reboot all of the cluster units at the same time so that the age of all of the
cluster units is reset. However, rebooting cluster units may interrupt or at least slow down traffic. If you would
rather not reboot all of the cluster units you can instead use the following command to reset the age of individual
cluster units.

diagnose sys ha reset-uptime

This command resets the age of a unit back to zero so that if no other unit in the cluster was reset at the same
time, it will now have the lowest age. You would use this command to reset the age of the cluster unit that is
currently the primary unit. Since it will have the lowest age, the other unit in the cluster will have the highest age
and can then become the primary unit.

The diagnose sys ha reset-uptime command should only be used as a
temporary solution. The command resets the HA age internally and does not affect the
up time displayed for cluster units using the diagnose sys ha dump-by all-
vcluster command or the up time displayed on the Dashboard or cluster members
list. To make sure the actual up time for cluster units is the same as the HA age you
should reboot the cluster units during a maintenance window.

Primary unit selection and device priority

A cluster unit with the highest device priority becomes the primary unit when the cluster starts up or renegotiates.
By default, the device priority for all cluster units is 128. You can change the device priority to control which
FortiGate becomes the primary unit during cluster negotiation. All other factors that influence primary unit
selection either cannot be configured (age and serial number) or are synchronized among all cluster units
(interface monitoring). You can set a different device priority for each cluster unit. During negotiation, if all
monitored interfaces are connected, and all cluster units enter the cluster at the same time (or have the same
age), the cluster with the highest device priority becomes the primary unit.

A higher device priority does not affect primary unit selection for a cluster unit with the most failed monitored
interfaces or with an age that is higher than all other cluster units because failed monitored interfaces and age are
used to select a primary unit before device priority.

Increasing the device priority of a cluster unit does not always guarantee that this cluster unit will become the
primary unit. During cluster operation, an event that may affect primary unit selection may not always result in the
cluster renegotiating. For example, when a unit joins a functioning cluster, the cluster will not renegotiate. So if a
unit with a higher device priority joins a cluster the new unit becomes a subordinate unit until the cluster
renegotiates.
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Enabling the override HACLI keyword makes changes in device priority more
effective by causing the cluster to negotiate more often to make sure that the primary
unit is always the unit with the highest device priority. For more information about
override, see Primary unit selection on page 1744.

Controlling primary unit selection by changing the device priority

You set a different device priority for each cluster unit to control the order in which cluster units become the
primary unit when the primary unit fails.

To change the device priority from the GUI go to System > HA and change the Device priority.

Enter the following CLI command to change the device priority to 200:

config system ha
set priority 200

end

The device priority is not synchronized among cluster units. In a functioning cluster you can change the device
priority of any unit in the cluster. Whenever you change the device priority of a cluster unit, when the cluster
negotiates, the unit with the highest device priority becomes the primary unit.

The following example shows how to change the device priority of a subordinate unit to 255 so that this
subordinate unit becomes the primary unit. You can change the device priority of a subordinate unit by going to
System > HA and selecting the Edit icon for the subordinate unit. Or from the CLI you can use the execute
ha manage 0 command to connect to the highest priority subordinate unit. After you enter the following
commands the cluster renegotiates and selects a new primary unit.

execute ha manage 1
config system ha

set priority 255
end

If you have three units in a cluster you can set the device priorities as shown below. When the cluster starts up,
cluster unit A becomes the primary unit because it has the highest device priority. If unit A fails, unit B becomes
the primary unit because unit B has a higher device priority than unit C.

Example device priorities for a cluster of three FortiGates

Cluster unit Device priority

A 200

B 100

C 50

When configuring HA you do not have to change the device priority of any of the cluster units. If all cluster units
have the same device priority, when the cluster first starts up the FGCP negotiates to select the cluster unit with
the highest serial number to be the primary unit. Clusters also function normally if all units have the same device
priority.

You can change the device priority if you want to control the roles that individual units play in the cluster. For
example, if you want the same unit to always become the primary unit, set this unit device priority higher than the
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device priority of other cluster units. Also, if you want a cluster unit to always become a subordinate unit, set this
cluster unit device priority lower than the device priority of other cluster units.

If you have a cluster of three units you can set a different priority for each unit to control which unit becomes the
primary unit when all three cluster units and functioning and which will be the primary unit when two cluster units
are functioning.

The device priority range is 0 to 255. The default device priority is 128.

If you are configuring a virtual cluster, if you have added virtual domains to both virtual clusters, you can set the
device priority that the cluster unit has in virtual cluster 1 and virtual cluster 2. If a FortiGate has different device
priorities in virtual cluster 1 and virtual cluster 2, the FortiGate may be the primary unit in one virtual cluster and
the subordinate unit in the other.

Primary unit selection and the FortiGate serial number

The cluster unit with the highest serial number is more likely to become the primary unit. When first configuring
FortiGates to be added to a cluster, if you do not change the device priority of any cluster unit, then the cluster
unit with the highest serial number always becomes the primary unit.

Age does take precedence over serial number, so if a cluster unit takes longer to join a cluster for some reason
(for example if one cluster unit is powered on after the others), that cluster unit will not become the primary unit
because the other units have been in the cluster longer.

Device priority and failed monitored interfaces also take precedence over serial number. A higher device priority
means a higher priority. So if you set the device priority of one unit higher or if a monitored interface fails, the
cluster will not use the FortiGate serial number to select the primary unit.

Points to remember about primary unit selection

Some points to remember about primary unit selection:

l The FGCP compares primary unit selection criteria in the following order: Failed Monitored interfaces > Age >
Device Priority > Serial number. The selection process stops at the first criteria that selects one cluster unit.

l Negotiation and primary unit selection is triggered if a cluster unit fails or if a monitored interface fails.
l If the HA age difference is more than 5 minutes (300 seconds), the cluster unit that is operating longer becomes the

primary unit.
l If HA age difference is less than 5 minutes (300 seconds), the device priority and FortiGate serial number selects

the cluster unit to become the primary unit.
l Every time a monitored interface fails the HA age of the cluster unit is reset to 0.
l Every time a cluster unit restarts the HA age of the cluster unit is reset to 0.

HA override
The HA override CLI keyword is disabled by default. When override is disabled a cluster may not always
renegotiate when an event occurs that affects primary unit selection. For example, when override is disabled a
cluster will not renegotiate when you change a cluster unit device priority or when you add a new cluster unit to a
cluster. This is true even if the unit added to the cluster has a higher device priority than any other unit in the
cluster. Also, when override is disabled a cluster does not negotiate if the new unit added to the cluster has a
failed or disconnected monitored interface.
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For a virtual cluster configuration, override is enabled by default for both virtual
clusters when you enable virtual cluster 2. For more information, see Virtual clusters
on page 1850.

In most cases you should keep override disabled to reduce how often the cluster negotiates. Frequent
negotiations may cause frequent traffic interruptions.

However, if you want to make sure that the same cluster unit always operates as the primary unit and if you are
less concerned about frequent cluster negotiation you can set its device priority higher than other cluster units and
enable override.

To enable override, connect to each cluster unit CLI (using the execute ha manage command) and use
the config system ha CLI command to enable override.

For override to be effective, you must also set the device priority highest on the cluster unit that you want to
always be the primary unit. To increase the device priority, from the CLI use the config system ha
command and increase the value of the priority keyword to a number higher than the default priority of 128.

You can also increase the device priority from the GUI by going to System > HA. To increase the device priority
of the primary unit select edit for the primary or subordinate unit and set the Device Priority to a number higher
than 128.

The override setting and device priority value are not synchronized to all cluster
units. You must enable override and adjust device priority manually and separately for
each cluster unit.

With override enabled, the primary unit with the highest device priority will always become the primary unit.
Whenever an event occurs that may affect primary unit selection, the cluster negotiates. For example, when
override is enabled a cluster renegotiates when you change the device priority of any cluster unit or when you
add a new unit to a cluster.

Override and primary unit selection

Enabling override changes the order of primary unit selection. As shown below, if override is enabled,
primary unit selection considers device priority before age and serial number. This means that if you set the
device priority higher on one cluster unit, with override enabled this cluster unit becomes the primary unit even
if its age and serial number are lower than other cluster units.

Similar to when override is disabled, when override is enabled primary unit selection checks for connected
monitored interfaces first. So if interface monitoring is enabled, the cluster unit with the most disconnected
monitored interfaces cannot become the primary unit, even of the unit has the highest device priority.

If all monitored interfaces are connected (or interface monitoring is not enabled) and the device priority of all
cluster units is the same then age and serial number affect primary unit selection.
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Controlling primary unit selection using device priority and override

To configure one cluster unit to always become the primary unit you should set its device priority to be higher than
the device priorities of the other cluster units and you should enable override on all cluster units.

Using this configuration, when the cluster is operating normally the primary unit is always the unit with the highest
device priority. If the primary unit fails the cluster renegotiates to select another cluster unit to be the primary unit.
If the failed primary unit recovers, starts up again and rejoins the cluster, because override is enabled, the
cluster renegotiates. Because the restarted primary unit has the highest device priority it once again becomes the
primary unit.

In the same situation with override disabled, because the age of the failed primary unit is lower than the age
of the other cluster units, when the failed primary unit rejoins the cluster it does not become the primary unit.
Instead, even though the failed primary unit may have the highest device priority it becomes a subordinate unit
because its age is lower than the age of all the other cluster units.
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Points to remember about primary unit selection when override is enabled

Some points to remember about primary unit selection when override is enabled:

l The FGCP compares primary unit selection criteria in the following order: Failed Monitored Interfaces > Device
Priority > Age > Serial number. The selection process stops at the first criteria that selects one cluster unit.

l Negotiation and primary unit selection is triggered whenever an event occurs which may affect primary unit
selection. For example negotiation occurs, when you change the device priority, when you add a new unit to a
cluster, if a cluster unit fails, or if a monitored interface fails.

l Device priority is considered before age. Otherwise age is handled the same when override is enabled.

Configuration changes can be lost if override is enabled

In some cases, when override is enabled and you make configuration changes to an HA cluster these changes
can be lost. For example, consider the following sequence:

1. A cluster of two FortiGates is operating with override enabled.
l FGT-A: Primary unit with device priority 200 and with override enabled
l FGT-B: Subordinate unit with device priority 100 and with override disabled
l If both units are operating, FGT-A always becomes the primary unit because FGT-A has the highest device

priority.

2. FGT-A fails and FGT-B becomes the new primary unit.
3. The administrator makes configuration changes to the cluster.

The configuration changes are made to FGT-B because FGT-B is operating as the primary unit. These
configuration changes are not synchronized to FGT-A because FGT-A is not operating.

4. FGT-A is restored and starts up again.
5. The cluster renegotiates and FGT-A becomes the new primary unit.
6. The cluster recognizes that the configurations of FGT-A and FGT-B are not the same.
7. The configuration of FGT-A is synchronized to FGT-B.

The configuration is always synchronized from the primary unit to the subordinate units.
8. The cluster is now operating with the same configuration as FGT-A. The configuration changes made to FGT-B

have been lost.

The solution

When override is enabled, you can prevent configuration changes from being lost by doing the following:

l Verify that all cluster units are operating before making configuration changes (from the GUI go to System > HA to
view the cluster members list or from the FortiOS CLI enter get system ha status).

l Make sure the device priority of the primary unit is set higher than the device priorities of all other cluster units
before making configuration changes.

l Disable override either permanently or until all configuration changes have been made and synchronized to all
cluster units.

Override and disconnecting a unit from a cluster

A similar scenario to that described above may occur when override is enabled and you use the Disconnect
from Cluster option from the GUI or the execute ha disconnect command from the CLI to disconnect a
cluster unit from a cluster.
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Configuration changes made to the cluster can be lost when you reconnect the disconnected unit to the cluster.
You should make sure that the device priority of the disconnected unit is lower than the device priority of the
current primary unit. Otherwise, when the disconnected unit joins the cluster, if override is enabled, the cluster
renegotiates and the disconnected unit may become the primary unit. If this happens, the configuration of the
disconnected unit is synchronized to all other cluster units and any configuration changes made between when
the unit was disconnected and reconnected are lost.

Delaying how quickly the primary unit rejoins the cluster when override is enabled

In some cases when override is enabled and the unit designated to be the primary unit rejoins the cluster it will
become the primary unit too soon and cause traffic disruption. This can happen, for example, if one of the
FortiGate interfaces gets its address using PPPoE. If the backup unit is operating as the primary unit and
processing traffic, when the primary unit comes up it may need a short time to get a new IP address from the
PPPoE server. If the primary unit takes over the cluster before it has an IP address, traffic will be disrupted until
the primary unit gets its address.

You can resolve this problem by using the following command to add a wait time. In this example the wait time is
10 seconds. The wait time range is 0 to 3600 seconds and the default wait time is 0 seconds.

config system ha
set override-wait-time 10

end

With this wait time configured, after the primary unit is up and running it has 10 seconds to synchronize sessions,
get IP address(es) from PPPoE and DHCP servers and so on. After 10 seconds the primary unit sends gratuitous
arp packets and all traffic to the cluster is sent to the new primary unit. You can adjust the wait time according to
the conditions on your network.

FortiGate HA compatibility with DHCP and PPPoE
FortiGate HA is compatible with DHCP and PPPoE but care should be taken when configuring a cluster that
includes a FortiGate interface configured to get its IP address with DHCP or PPPoE. Fortinet recommends that
you turn on DHCP or PPPoE addressing for an interface after the cluster has been configured. If an interface is
configured for DHCP or PPPoE, turning on high availability may result in the interface receiving an incorrect
address or not being able to connect to the DHCP or PPPoE server correctly.

You cannot switch to operate in HAmode if one or more FortiGate interfaces is
configured as a PPTP or L2TP client.

You can configure a cluster to act as a DHCP server or a DHCP relay agent. In both active-passive and active-
active clusters DHCP relay sessions are always handled by the primary unit. It is possible that a DHCP relay
session could be interrupted by a failover. If this occurs the DHCP relay session is not resumed after the failover
and the DHCP client may have to repeat the DHCP request.

When a cluster is operating as a DHCP server the primary unit responds to all DHCP requests and maintains the
DHCP server address lease database. The cluster also dynamically synchronizes the DHCP server address lease
database to the subordinate units. If a failover occurs, the new primary unit will have an up-to-date DHCP server
address lease database. Synchronizing the DHCP address lease database prevents the new primary unit from
responding incorrectly to new DHCP requests after a failover.

Also, it is possible that when FortiGates first negotiate to form a cluster that a unit that ends up as a subordinate
unit in the cluster will have information in its DHCP address lease database that the cluster unit operating as the
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primary unit does note have. This can happen if a FortiGate responds to DHCP requests while operating as a
standalone unit and then when the cluster is formed this unit becomes a subordinate unit. Because of this
possibility, after a cluster is formed the DHCP address lease databases of all of the cluster units are merged into
one database which is then synchronized to all cluster units.

HA and distributed clustering
The FGCP supports widely separated cluster units installed in different physical locations. Distributed clusters
can have cluster units in different rooms in the same building, different buildings in the same location, or even
different geographical sites such as different cities, countries or continents.

Just like any cluster, distributed clusters require heartbeat communication between cluster units. In a distributed
cluster this heartbeat communication can take place over the Internet or over other transmission methods
including satellite linkups.

Most Data Center Interconnect (DCI) or MPLS-based solutions that support layer 2 extensions between the
remote data centers should also support HA heartbeat communication between the FortiGates in the distributed
locations. Using VLANs and switches in promiscuous mode to pass all traffic between the locations can also be
helpful.

HA heartbeat IP addresses are not configurable so the heartbeat interfaces have to be able to communication
over the same subnet. See HA heartbeat interface IP addresses on page 1914.

Because of the possible distance it may take a relatively long time for heartbeat packets to be transmitted
between cluster units. This could lead to a split brain scenario. To avoid a split brain scenario you can increase
the heartbeat interval so that the cluster expects extra time between heartbeat packets. A general rule is to
configure the failover time to be longer than the max latency. You could also increase the hb-lost-
threshold to tolerate losing heartbeat packets if the network connection is less reliable.
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In addition you could use different link paths for heartbeat packets to optimize HA heartbeat communication. You
could also configure QoS on the links used for HA heartbeat traffic to make sure heartbeat communication has
the highest priority.

For information about changing the heartbeat interval and other heartbeat related settings, see Modifying
heartbeat timing on page 1916.

Clusters of three or four FortiGates
The FGCP supports a cluster of two, three, or four FortiGates. You can add more than two units to a cluster to
improve reliability: if two cluster units fail the third will continue to operate and so on. A cluster of three or four
units in active-active mode may improve performance since another cluster unit is available for security profile
processing. However, active-active FGCPHA results in diminishing performance returns as you add units to the
cluster, so the additional performance achieved by adding the third cluster unit may not be worth the cost.

There are no special requirements for clusters of more than two units. Here are a few recommendations though:

l The matching heartbeat interfaces of all of the cluster units must be able to communicate with each other. So each
unit's matching heartbeat interface should be connected to the same switch. If the ha1 interface is used for
heartbeat communication, then the ha1 interfaces of all of the units in the cluster must be connected together so
communication can happen between all of the cluster units over the ha1 interface.

l Redundant heartbeat interfaces are recommended. You can reduce the number of points of failure by connecting
each matching set of heartbeat interfaces to a different switch. This is not a requirement; however, and you can
connect both heartbeat interfaces of all cluster units to the same switch. However, if that switch fails the cluster will
stop forwarding traffic.

l For any cluster, a dedicated switch for each heartbeat interface is recommended because of the large volume of
heartbeat traffic and to keep heartbeat traffic off of other networks, but it is not required.

l Full mesh HA can scale to three or four FortiGates. Full mesh HA is not required if you have more than 2 units in a
cluster.

l Virtual clustering can only be done with two FortiGates.

Connecting a cluster of three FortiGates

This example shows how to connect a cluster of three FortiGates where:

l Port1 connects the cluster to the Internet
l Port2 connects the cluster to the internal network
l Port3 and Port4 are the heartbeat interfaces

Use the following steps to connect the cluster units to each other and to their networks:
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1. Connect the network interfaces:
l Connect the port1 interface of each FortiGate to the same switch (Switch 1) and connect this switch to the

Internet.
l Connect the port2 interface of each FortiGate to the same switch (Switch 2) and connect this switch to the

internal Network.

Connecting the network interfaces (cluster of three FortiGates)
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2. Connect the heartbeat interfaces:
l Connect the port3 interface of each FortiGate to the same switch (Switch 3)
l Connect the port4 interface of each FortiGate to the same switch (Switch 4)

Connecting the heartbeat interfaces (cluster of three FortiGates)
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The network and heartbeat connections when combined into one diagram appear like the following:

Network and heartbeat interface connections (cluster of three FortiGates)

Disk storage configuration and HA
If your cluster units include storage disks (for example for storing log messages, WAN optimization data and web
caching) all cluster units must have identical storage disk configurations. This means each cluster unit must have
same number of disks (including AMC and FortiGate Storage Module (FSM) hard disks) and also means that
matching disks in each cluster unit must be the same size, have the same format, and have the same number of
partitions.

In most cases the default hard disk configuration of the cluster units will be compatible. However, a hard disk
formatted by an older FortiGate firmware version may not be compatible with a hard disk formatted by a more
recent firmware version. Problemsmay also arise if you have used the execute scsi-dev command to add
or change hard disk protections.

If a cluster unit CLI displays hard disk compatibility messages, you may need to use the execute scsi-dev
delete command to delete partitions. You can also use the execute formatlogdisk command to
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reformat disks. In some cases after deleting all partitions and reformatting the disks, you may still see disk
incompatibility messages. If this happens, contact Fortinet Customer Support for assistance.

FGCP high availability best practices
Fortinet suggests the following practices related to high availability:

l Use Active-Active HA to distribute TCP and UTM sessions among multiple cluster units. An active-active cluster
may have higher throughput than a standalone FortiGate unit or than an active-passive cluster.

l Use a different host name on each FortiGate unit when configuring an HA cluster. Fewer steps are required to add
host names to each cluster unit before configuring HA and forming a cluster.

l Consider adding an Alias to the interfaces used for the HA heartbeat so that you always get a reminder about what
these interfaces are being used for.

l Enabling load-balance-all can increase device and network load since more traffic is load-balanced. This
may be appropriate for use in a deployment using the firewall capabilities of the FortiGate unit and IPS but no other
content inspection.

l An advantage of using session pickup is that non-content inspection sessions will be picked up by the new primary
unit after a failover. The disadvantage is that the cluster generates more heartbeat traffic to support session pickup
as a larger portion of the session table must be synchronized. Session pickup should be configured only when
required and is not recommended for use with SOHO FortiGate models. Session pickup should only be used if the
primary heartbeat link is dedicated (otherwise the additional HA heartbeat traffic could affect network performance).

l If session pickup is not selected, after a device or link failover all sessions are briefly interrupted and must be re-
established at the application level after the cluster renegotiates. For example, after a failover, users browsing the
web can just refresh their browsers to resume browsing. Users downloading large files may have to restart their
download after a failover. Other protocols may experience data loss and some protocols may require sessions to be
manually restarted. For example, a user downloading files with FTPmay have to either restart downloads or restart
their FTP client.

l If you need to enable session pickup, consider enabling session-pickup-delay to improve performance by
reducing the number of sessions that are synchronized. See Improving session synchronization performance on
page 1954.

l Consider using the session-sync-dev option to move session synchronization traffic off the HA heartbeat link
to one or more dedicated session synchronization interfaces.See Improving session synchronization performance
on page 1954.

l To avoid unpredictable results, when you connect a switch to multiple redundant or aggregate interfaces in an
active-passive cluster you should configure separate redundant or aggregate interfaces on the switch; one for each
cluster unit.

l Use SNMP, syslog, or email alerts to monitor a cluster for failover messages. Alert messages about cluster failovers
may help find and diagnose network problems quickly and efficiently.

Heartbeat interfaces

Fortinet suggests the following practices related to heartbeat interfaces:

Do not use a FortiGate switch port for the HA heartbeat traffic. This configuration is
not supported.
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l Configure at least two heartbeat interfaces and set these interfaces to have different priorities.
l For clusters of two FortiGate units, as much as possible, heartbeat interfaces should be directly connected using

patch cables (without involving other network equipment such as switches). If switches have to be used they should
not be used for other network traffic that could flood the switches and cause heartbeat delays.
l If you cannot use a dedicated switch, the use of a dedicated VLAN can help limit the broadcast domain to

protect the heartbeat traffic and the bandwidth it creates.
l For clusters of three or four FortiGate units, use switches to connect heartbeat interfaces. The corresponding

heartbeat interface of each FortiGate unit in the cluster must be connected to the same switch. For improved
redundancy use a different switch for each heartbeat interface. In that way if the switch connecting one of the
heartbeat interfaces fails or is unplugged, heartbeat traffic can continue on the other heartbeat interfaces and
switch.

l Isolate heartbeat interfaces from user networks. Heartbeat packets contain sensitive cluster configuration
information and can consume a considerable amount of network bandwidth. If the cluster consists of two FortiGate
units, connect the heartbeat interfaces directly using a crossover cable or a regular Ethernet cable. For clusters with
more than two units, connect heartbeat interfaces to a separate switch that is not connected to any network.

l If heartbeat traffic cannot be isolated from user networks, enable heartbeat message encryption and authentication
to protect cluster information. See Enabling or disabling HA heartbeat encryption and authentication on page 1917.

l Configure and connect redundant heartbeat interfaces so that if one heartbeat interface fails or becomes
disconnected, HA heartbeat traffic can continue to be transmitted using the backup heartbeat interface. If heartbeat
communication fails, all cluster members will think they are the primary unit resulting in multiple devices on the
network with the same IP addresses and MAC addresses (condition referred to asSplit Brain) and communication
will be disrupted until heartbeat communication can be reestablished.

l Do not monitor dedicated heartbeat interfaces; monitor those interfaces whose failure should trigger a device
failover.

l Where possible at least one heartbeat interface should not be connected to an NP4 or NP6 processor to avoid NP4
or NP6-related problems from affecting heartbeat traffic.

l Where possible, the heartbeat interfaces should not be connected to an NP4 or NP6 processor that is also
processing network traffic.

l Where possible, each heartbeat interface should be connected to a different NP4 or NP6 processor.
l Any FortiGate interface can be used as a heartbeat interface including 10/100/1000Base-T, SFP, QSFP fiber and

copper, and so on. If you set up two or more interfaces as heartbeat interfaces each interface can be a different
type and speed.

Interface monitoring (port monitoring)

Fortinet suggests the following practices related to interface monitoring (also called port monitoring):

l Wait until a cluster is up and running and all interfaces are connected before enabling interface monitoring. A
monitored interface can easily become disconnected during initial setup and cause failovers to occur before the
cluster is fully configured and tested.

l Monitor interfaces connected to networks that process high priority traffic so that the cluster maintains connections
to these networks if a failure occurs.

l Avoid configuring interface monitoring for all interfaces.
l Supplement interface monitoring with remote link failover. Configure remote link failover to maintain packet flow if

a link not directly connected to a cluster unit (for example, between a switch connected to a cluster interface and the
network) fails. See Remote link failover (remote IPmonitoring) on page 1943.
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FGCP HA terminology
The following HA-specific terms are used in this document.

Cluster

A group of FortiGates that act as a single virtual FortiGate to maintain connectivity even if one of the FortiGates
in the cluster fails.

Cluster unit

A FortiGate operating in a FortiGate HA cluster.

Device failover

Device failover is a basic requirement of any highly available system. Device failover means that if a device fails,
a replacement device automatically takes the place of the failed device and continues operating in the same
manner as the failed device.

Failover

A FortiGate taking over processing network traffic in place of another unit in the cluster that suffered a device
failure or a link failure.

Failure

A hardware or software problem that causes a FortiGate or a monitored interface to stop processing network
traffic.

FGCP

The FortiGate clustering protocol (FGCP) that specifies how the FortiGates in a cluster communicate to keep the
cluster operating.

Full mesh HA

Full mesh HA is a method of removing single points of failure on a network that includes an HA cluster. FortiGate
models that support redundant interfaces can be used to create a cluster configuration called full mesh HA. Full
mesh HA includes redundant connections between all network components. If any single component or any
single connection fails, traffic switches to the redundant component or connection.

HA virtual MAC address

When operating in HAmode, all of the interfaces of the primary unit acquire the same HA virtual MAC address.
All communications with the cluster must use this MAC address. The HA virtual MAC address is set according to
the group ID.

Heartbeat

Also called FGCP heartbeat or HA heartbeat. The heartbeat constantly communicates HA status and
synchronization information to make sure that the cluster is operating properly.
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Heartbeat device

An Ethernet network interface in a cluster that is used by the FGCP for heartbeat communications among cluster
units.

Heartbeat failover

If an interface functioning as the heartbeat device fails, the heartbeat is transferred to another interface also
configured as an HA heartbeat device.

Hello state

In the hello state a cluster unit has powered on in HAmode, is using HA heartbeat interfaces to send hello
packets, and is listening on its heartbeat interfaces for hello packets from other FortiGates. Hello state may
appear in HA log messages.

High availability

The ability that a cluster has to maintain a connection when there is a device or link failure by having another unit
in the cluster take over the connection, without any loss of connectivity. To achieve high availability, all
FortiGates in the cluster share session and configuration information.

Interface monitoring

You can configure interface monitoring (also called port monitoring) to monitor FortiGate interfaces to verify that
the monitored interfaces are functioning properly and connected to their networks. If a monitored interface fails or
is disconnected from its network the interface leaves the cluster and a link failover occurs. For more information
about interface monitoring, see Link failover (port monitoring or interface monitoring) on page 1936.

Link failover

Link failover means that if a monitored interface fails, the cluster reorganizes to re-establish a link to the network
that the monitored interface was connected to and to continue operating with minimal or no disruption of network
traffic.

Load balancing

Also known as active-active HA. All units in the cluster process network traffic. The FGCP employs a technique
similar to unicast load balancing. The primary unit interfaces are assigned virtual MAC addresses which are
associated on the network with the cluster IP addresses. The primary unit is the only cluster unit to receive
packets sent to the cluster. The primary unit can process packets itself, or propagate them to subordinate units
according to a load balancing schedule. Communication between the cluster units uses the actual cluster unit
MAC addresses.

Monitored interface

An interface that is monitored by a cluster to make sure that it is connected and operating correctly. The cluster
monitors the connectivity of this interface for all cluster units. If a monitored interface fails or becomes
disconnected from its network, the cluster will compensate.
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Primary unit

Also called the primary cluster unit, this cluster unit controls how the cluster operates. The primary unit sends
hello packets to all cluster units to synchronize session information, synchronize the cluster configuration, and to
synchronize the cluster routing table. The hello packets also confirm for the subordinate units that the primary
unit is still functioning.

The primary unit also tracks the status of all subordinate units. When you start a management connection to a
cluster, you connect to the primary unit.

In an active-passive cluster, the primary unit processes all network traffic. If a subordinate unit fails, the primary
unit updates the cluster configuration database.

In an active-active cluster, the primary unit receives all network traffic and re-directs this traffic to subordinate
units. If a subordinate unit fails, the primary unit updates the cluster status and redistributes load balanced traffic
to other subordinate units in the cluster.

The FortiGate firmware uses the term master to refer to the primary unit.

Session failover

Session failover means that a cluster maintains active network sessions after a device or link failover. FortiGate
HA does not support session failover by default. To enable session failover you must change the HA configuration
to select Enable Session Pick-up.

Session pickup

If you enable session pickup for a cluster, if the primary unit fails or a subordinate unit in an active-active cluster
fails, all communication sessions with the cluster are maintained or picked up by the cluster after the cluster
negotiates to select a new primary unit.

If session pickup is not a requirement of your HA installation, you can disable this option to save processing
resources and reduce the network bandwidth used by HA session synchronization. In many cases interrupted
sessions will resume on their own after a failover even if session pickup is not enabled. You can also enable
session pickup delay to reduce the number of sessions that are synchronized by session pickup.

Standby state

A subordinate unit in an active-passive HA cluster operates in the standby state. In a virtual cluster, a subordinate
virtual domain also operates in the standby state. The standby state is actually a hot-standby state because the
subordinate unit or subordinate virtual domain is not processing traffic but is monitoring the primary unit session
table to take the place of the primary unit or primary virtual domain if a failure occurs.

In an active-active cluster all cluster units operate in a work state.

When standby state appears in HA log messages this usually means that a cluster unit has become a subordinate
unit in an active-passive cluster or that a virtual domain has become a subordinate virtual domain.

State synchronization

The part of the FGCP that maintains connections after failover.
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Subordinate unit

Also called the subordinate cluster unit, each cluster contains one or more cluster units that are not functioning as
the primary unit. Subordinate units are always waiting to become the primary unit. If a subordinate unit does not
receive hello packets from the primary unit, it attempts to become the primary unit.

In an active-active cluster, subordinate units keep track of cluster connections, keep their configurations and
routing tables synchronized with the primary unit, and process network traffic assigned to them by the primary
unit. In an active-passive cluster, subordinate units do not process network traffic. However, active-passive
subordinate units do keep track of cluster connections and do keep their configurations and routing tables
synchronized with the primary unit.

The FortiGate firmware uses the terms slave and subsidiary unit to refer to a subordinate unit.

Virtual clustering

Virtual clustering is an extension of the FGCP for FortiGates operating with multiple VDOMS enabled. Virtual
clustering operates in active-passive mode to provide failover protection between two instances of a VDOM
operating on two different cluster units. You can also operate virtual clustering in active-active mode to use HA
load balancing to load balance sessions between cluster units. Alternatively, by distributing VDOM processing
between the two cluster units you can also configure virtual clustering to provide load balancing by distributing
sessions for different VDOMs to each cluster unit.

Work state

The primary unit in an active-passive HA cluster, a primary virtual domain in a virtual cluster, and all cluster units
in an active-active cluster operate in the work state. A cluster unit operating in the work state processes traffic,
monitors the status of the other cluster units, and tracks the session table of the cluster.

When work state appears in HA log messages this usually means that a cluster unit has become the primary unit
or that a virtual domain has become a primary virtual domain.

HA GUI options
Go to System > HA to change HA options. You can set the following options to put a FortiGate into HAmode.
You can also change any of these options while the cluster is operating.

You can configure HA options for a FortiGate with virtual domains (VDOMs) enabled by logging into the GUI as
the global admin administrator and going to System > HA.

If already operating in HAmode, go to System > HA to display the cluster members list. You can then edit the
primary unit to change HA settings.

Go to System > HA > View HA Statistics to view statistics about cluster operation.

Most virtual cluster HA options are the same as normal HA options. However, virtual
clusters include VDOM partitioning options. Other differences between configuration
options for regular HA and for virtual clustering HA are described below and see Virtual
clusters on page 1850.
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FortiGate HA is compatible with DHCP and PPPoE but care should be taken when
configuring a cluster that includes a FortiGate interface configured to get its IP
address with DHCP or PPPoE. Fortinet recommends that you turn on DHCP or PPPoE
addressing for an interface after the cluster has been configured. If an interface is
configured for DHCP or PPPoE, turning on high availability may result in the interface
receiving an incorrect address or not being able to connect to the DHCP or PPPoE
server correctly.

Mode

Select an HAmode for the cluster or return the FortiGate in the cluster to standalone mode. When configuring a
cluster, you must set all members of the HA cluster to the same HAmode. You can select Standalone (to disable
HA), Active-Passive, orActive-Active.

If virtual domains are enabled you can select Active-Passive or Standalone.

Device Priority

Optionally set the device priority of the cluster FortiGate. Each FortiGate in a cluster can have a different device
priority. During HA negotiation, the FortiGate with the highest device priority usually becomes the primary unit.

In a virtual cluster configuration, each cluster FortiGate can have two different device priorities, one for each
virtual cluster. During HA negotiation, the FortiGate with the highest device priority in a virtual cluster becomes
the primary FortiGate for that virtual cluster.

Changes to the device priority are not synchronized. You can accept the default device priority when first
configuring a cluster.

Synchronize Management VDOM

This options appears if you have enabled multiple VDOMS and set a VDOM other than the root VDOM to be the
management VDOM. You can disable this option to prevent the management VDOM configuration from being
synchronized between cluster units in the virtual cluster. This allows you to add an interface to the VDOM in each
cluster unit and then to give the Interface a different IP address in each cluster unit, allowing you to manage each
cluster unit separately.

You can also enable this feature using the following command:

config system ha
set standalone-mgmt-vdom enable

end

Group name

Enter a name to identify the cluster. The maximum length of the group name is 32 characters. The group name
must be the same for all cluster units before the cluster units can form a cluster. After a cluster is operating, you
can change the group name. The group name change is synchronized to all cluster units.

Password

Enter a password to identify the cluster. The password must be the same for all cluster FortiGates before the
cluster FortiGates can form a cluster.

Two clusters on the same network must have different passwords.
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The password is synchronized to all cluster units in an operating cluster. If you change the password of one
cluster unit the change is synchronized to all cluster units.

Session pickup

Select to enable session pickup so that if the primary unit fails, sessions are picked up by the cluster unit that
becomes the new primary unit.

You must enable session pickup for session failover protection. If you do not require session failover protection,
leaving session pickup disabled may reduce HACPU usage and reduce HA heartbeat network bandwidth usage.
See Session failover (session-pickup) on page 1953.

Monitor interfaces

Select to enable or disable monitoring FortiGate interfaces to verify the monitored interfaces are functioning
properly and are connected to their networks. See Link failover (port monitoring or interface monitoring) on page
1936.

If a monitored interface fails or is disconnected from its network, the interface leaves the cluster and a link failover
occurs. The link failover causes the cluster to reroute the traffic being processed by that interface to the same
interface of another cluster FortiGate that still has a connection to the network. This other cluster FortiGate
becomes the new primary unit.

Interface monitoring (also called port monitoring) is disabled by default. Leave interface monitoring disabled until
the cluster is operating and then only enable interface monitoring for connected interfaces.

You can monitor up to 64 interfaces.

Heartbeat interfaces

Enable or disable HA heartbeat communication for each interface in the cluster and set the heartbeat interface
priority. The heartbeat interface with the highest priority processes all heartbeat traffic. If two or more heartbeat
interfaces have the same priority, the heartbeat interface with the lowest hash map order value processes all
heartbeat traffic. The GUI lists interfaces in alphanumeric order:

l port1
l port2 through 9
l port10

Hash map order sorts interfaces in the following order:

l port1
l port10
l port2 through port9

The default heartbeat interface configuration is different for each FortiGate model. This default configuration
usually sets the priority of two heartbeat interfaces to 50. You can accept the default heartbeat interface
configuration or change it as required.

The heartbeat interface priority range is 0 to 512. The default priority when you select a new heartbeat interface is
0.

You must select at least one heartbeat interface. If heartbeat communication is interrupted, the cluster stops
processing traffic. See HA heartbeat and communication between cluster units on page 1911.

You can select up to 8 heartbeat interfaces. This limit only applies to units with more than 8 physical interfaces.
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Management Interface Reservation

You can provide direct management access to individual cluster units by reserving a management interface as
part of the HA configuration. Once this management interface is reserved, you can configure a different IP
address, administrative access and other interface settings for this interface for each cluster unit. You can also
specify static routing settings for this interface. Then by connecting this interface of each cluster unit to your
network you can manage each cluster unit separately from a different IP address. See Managing individual
cluster units using a reserved out-of-band management interface on page 1875.

VDOM partitioning

If you are configuring virtual clustering, you can set the virtual domains to be in virtual cluster 1 and the virtual
domains to be in virtual cluster 2. The root virtual domain must always be in virtual cluster 1.

Secondary Cluster Settings

If you are configuring virtual clustering you can set the device priority and configure interface monitoring for the
secondary virtual cluster.
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This chapter contains general procedures and descriptions as well as detailed configuration examples that
describe how to configure FortiGate HA clusters.

About the examples in this chapter
The procedures in this chapter describe some of many possible sequences of steps for configuring HA clustering.
As you become more experienced with FortiOS HA you may choose to use a different sequence of configuration
steps.

For simplicity, many of these procedures assume that you are starting with new FortiGates set to the factory
default configuration. However, starting from the default configuration is not a requirement for a successful HA
deployment. FortiGate HA is flexible enough to support a successful configuration from many different starting
points.

The examples in this chapter include example values only. In most cases you will substitute your own values. The
examples in this chapter also do not contain detailed descriptions of configuration parameters.

How to set up FGCP clustering (recommended steps)
This example describes how to enhance the reliability of a network protected by a FortiGate unit by adding a
second FortiGate unit and setting up a FortiGate Clustering Protocol (FGCP) High Availability cluster.

The FortiGate already on the network will be configured to become the primary unit by:

l Licensing it (if required)
l Enabling HA
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l Increasing its device priority
l Enabling override

The new FortiGate will be prepared by:

l Setting it to factory defaults to wipe any configuration changes
l Licensing it (if required)
l Enabling HAwithout changing the device priority and override
l Connecting it to the FortiGate already on the network.

The new FortiGate becomes the backup unit and its configuration is overwritten by the primary unit.

Before you start, the FortiGates should be running the same FortiOS firmware version and interfaces should not
be configured to get their addresses from DHCP or PPPoE. Also, you cannot use a switch port as an HA heartbeat
interface. If necessary, convert the switch port to individual interfaces.

1. Configuring the primary FortiGate

Connect to the primary FortiGate
and locate the System Information
Dashboard widget. Click on the
System Information dashboard
widget and select Configure
settings in System > Settings.
Change the unit'sHost name to
identify it as the primary FortiGate.

You can also enter this CLI
command:

config system global
   set hostname External-Primary
end
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Register and apply licenses to the
primary FortiGate before configuring
it for HA operation. This includes
licensing for FortiCare Support,
IPS, AntiVirus, Web Filtering,
Mobile Malware, FortiClient,
FortiCloud, and additional virtual
domains (VDOMs). All FortiGates
in the cluster must have the same
level of licensing for FortiGuard,
FortiCloud, FortiClient, and
VDOMs. FortiToken licenses can
be added at any time because they
are synchronized to all cluster
members.

If the FortiGates in the cluster will
be running FortiOS Carrier, apply
the FortiOS Carrier license before
configuring the cluster (and before
applying other licenses). Applying
the FortiOS Carrier license sets the
configuration to factory defaults,
requiring you to repeat steps
performed before applying the
license.

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed, third-party certificates are synchronized to the backup FortiGate.

Enter this CLI command to set the
HAmode to active-passive, set a
group id, group name and password,
increase the device priority to a
higher value (for example, 250) and
enable override.

config system ha
set mode a-p
set group-id 25

  set group-name External-HA-Cluster
set password
set priority 250
set override enable
set hbdev port3 200 port4 100

end

Enabling override and increasing the device priority means this unit should always become the primary unit.

This command also selects port3 and port4 to be the heartbeat interfaces and sets their priorities to 200 and
100 respectively. Its a best practice to set different priorities for the heartbeat interfaces (but not a
requirement).

If you have more than one cluster on the same network, each cluster should have a different group id.
Changing the group id changes the cluster interface virtual MAC addresses. If your group id setting causes
MAC address conflict you can select a different group id.
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You can also use the GUI (System
> HA) to configure most of these
settings.

Override and the group id can only
be configured from the CLI.

config system ha
set group-id 25

  set override enable
end

The FortiGate unit negotiates to establish an HA cluster. You may temporarily lose connectivity with the
FortiGate unit as FGCP negotiation takes place and the MAC addresses of the FortiGate interfaces are
changed to HA virtual MAC addresses. These virtual MAC addresses are used for failover. The actual virtual
MAC address assigned to each FortiGate interface depends on the HA group ID. Since this example does
not involve changing the HA group ID, the FortiGate unit's interfaces will have the following MAC addresses:
00:09:0f:09:00:00, 00:09:0f:09:00:01, 00:09:0f:09:00:02 and so on.

If these steps don't start HAmode, make sure that none of the FortiGate's interfaces use DHCP or PPPoE
addressing.

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP table
entry for the FortiGate unit (or just deleting all ARP table entries). You can usually delete the ARP table from
a command prompt using a command similar to arp -d.To confirm these MAC address changes, you can
use the get hardware nic (or diagnose hardware deviceinfo nic) command to view the
virtual MAC address of any FortiGate unit interface. Depending on the FortiGate model, the output from
this command could include lines similar to the following:

Current_HWaddr: 00:09:0f:09:00:00
Permanent_HWaddr 02:09:0f:78:18:c9

2. Configuring the backup FortiGate
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Enter this command to reset the new FortiGate that will become the backup FortiGate to factory default
settings.

execute factoryreset

You can skip this step if the new FortiGate is fresh from the factory. But if its configuration has been
changed at all it is recommended to set it back to factory defaults to reduce the chance of synchronization
problems.

If required, change the firmware running on the new FortiGate to be the same version as is running on the
primary unit.

Register and apply licenses to the
new FortiGate unit before adding it
to the HA cluster. This includes
licensing for FortiCare Support,
IPS, AntiVirus, Web Filtering,
Mobile Malware, FortiClient,
FortiCloud, and additional virtual
domains (VDOMs). All FortiGates
in the cluster must have the same
level of licensing for FortiGuard,
FortiCloud, FortiClient, and
VDOMs. FortiToken licenses can
be added at any time because they
are synchronized to all cluster
members.

If the FortiGates in the cluster will
be running FortiOS Carrier, apply
the FortiOS Carrier license before
configuring the cluster (and before
applying other licenses). Applying
the FortiOS Carrier license sets the
configuration to factory defaults,
requiring you to repeat steps
performed before applying the
license.

Click on the System Information
dashboard widget and select
Configure settings in System >
Settings. Change the FortiGate's
Host name to identify it as the
backup FortiGate.

You can also enter this CLI
command:

config system global
set hostname External-Backup

end
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Duplicate the primary unit HA
settings, except set the Device
Priority to a lower value (for
example, 50) and do not enable
override.

If these steps don't start HAmode,
make sure that none of the
FortiGate's interfaces use DHCP or
PPPoE addressing,

config system ha
set mode a-p

 set group-id 25
set group-name External-HA-Cluster
set password
set priority 50
set hbdev port3 200 port4 100
end

3. Connecting the cluster

Connect the HA cluster as shown in the network diagram. Making these connections will disrupt network
traffic as you disconnect and re-connect cables.

If possible, make direct Ethernet connections between the heartbeat interfaces of the two FortiGate units.

This example uses two port3 and port4, but you can use any interfaces for HA heartbeat interfaces. A best
practice is to use interfaces that do not process traffic, but this is not a requirement.

Switches must be used between the cluster and the Internet and between the cluster and the internal
networks as shown in the network diagram. You can use any good quality switches to make these
connections. You can also use one switch for all of these connections as long as you configure the switch to
separate traffic from the different networks.

When connected, the primary and backup FortiGates find each other and negotiate to form an HA cluster.
The Primary unit synchronizes its configuration with the backup FortiGate. Forming the cluster happens
automatically with minimal or no disruption to network traffic.

4. Checking cluster operation and disabling override

Check the cluster synchronization status to make sure the primary and backup units have the same
configuration. Log into the primary unit CLI and enter this command:

diagnose sys ha checksum cluster

The command output lists all cluster members' configuration checksums. If both cluster units have identical
checksums you can be sure that their configurations are synchronized. If the checksums are different, wait a
short while and enter the command again. Repeat until the checksums are identical. It may take a while for
some parts of the configuration to be synchronized. If the checksums never become identical visit the
Fortinet Support website to find help with troubleshooting the problem.
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The HA Status Dashboard widget
also shows if the cluster units are
synchronized. Mouse over each
FortiGate in the cluster to verify that
they both have the same checksum.

When the checksums are identical, disable override on the primary unit (recommended).

config system ha
 set override disable
end

The HA cluster dynamically responds to network conditions. If you keep override enabled, the same
FortiGate will always be the primary FortiGate. Because of this, however; the cluster may negotiate more
often potentially increasing traffic disruptions.

If you disable override it is more likely that the new FortiGate unit could become the primary unit. Disabling
override is recommended unless its important that the same FortiGate remains the primary unit.

From the HA Status widget, select Configure Settings in System > HA (or go to System > HA) to
view the cluster status.

From the HA Statuswidget you can also select Show HA Historical Events to see the most recent HA
system status messages.
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5. Results

Normally, traffic should now be flowing through the primary FortiGate. If the primary FortiGate is
unavailable traffic fails over to the backup FortiGate. Failover also causes the primary and backup
FortiGates to reverse roles, even when both FortiGates are available again.

To test this, ping the IP address
8.8.8.8 using a PC on the internal
network. After a moment, power off
the primary FortiGate.

If you are using port monitoring, you
can also unplug the primary
FortiGate's Internet-facing interface
to test failover.

You will see a momentary pause in
the ping results, until traffic diverts
to the backup FortiGate, allowing
the ping traffic to continue.

Setting up two new FortiGates as an FGCP cluster
This section describes a simple HA network topology that includes an HA cluster of two FortiGates in NAT mode
installed between an internal network and the Internet. The example uses a generic FortiGate with four interfaces
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named port1, port2, port3 and port4.

Example NAT mode HA network topology

The figure below shows a typical FortiGate HA cluster consisting of two FortiGates (FGT_ha_1 and FGT_ha_2)
connected to the same internal (port2) and external (port1) networks.

Example NAT mode HA network topology

Port3 and port4 are used as the heartbeat interfaces. Because the cluster consists of two FortiGates, you can
make the connections between the heartbeat interfaces using crossover cables. You could also use switches and
regular Ethernet cables.

General configuration steps

The section includes GUI and CLI procedures. These procedures assume that the FortiGates are running the
same FortiOS firmware build and are set to the factory default configuration.

General configuration steps

1. Apply licenses to the FortiGates to become the cluster.
2. Configure the FortiGates for HA operation.
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l Optionally change each unit’s host name.
l Configure HA.

2. Connect the cluster to the network.
3. Confirm that the cluster units are operating as a cluster and add basic configuration settings to the cluster.

l View cluster status from the GUI or CLI.
l Add a password for the admin administrative account.
l Change the IP addresses and netmasks of the internal and external interfaces.
l Add a default route.

Configuring a NAT mode active-passive cluster of two FortiGates - GUI

Use the following procedures to configure two FortiGates for NAT HA operation using the GUI. These procedures
assume you are starting with two FortiGates with factory default settings.

Give each cluster unit a unique host name to make the individual units easier to
identify when they are part of a functioning cluster. The default host name is the
FortiGate serial number. You may want to change this host name to something more
meaningful for your network.

To configure the first FortiGate (host name FGT_ha_1)

1. Register and apply licenses to the FortiGate before configuring it for HA operation. This includes licensing for
FortiCare Support, IPS, AntiVirus, Web Filtering, Mobile Malware, FortiClient, FortiCloud, and
additional virtual domains (VDOMs). All FortiGates in the cluster must have the same level of licensing for
FortiGuard, FortiCloud, FortiClient, and VDOMs. FortiToken licenses can be added at any time because they are
synchronized to all cluster members.

If the FortiGates in the cluster will be running FortiOS Carrier, apply the FortiOS Carrier license before configuring
the cluster (and before applying other licenses). Applying the FortiOS Carrier license sets the configuration to
factory defaults, requiring you to repeat steps performed before applying the license.

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed, third-party certificates are synchronized to the backup FortiGate.
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2. Click on the System Information dashboard widget and select Configure settings in System > Settings.
3. Enter a new Host Name for this FortiGate.

New Name FGT_ha_1

4. Select OK.
5. Go to System > HA and change the following settings:

Mode Active-Passive

Group name example1.com

Password HA_pass_1

This is the minimum recommended configuration for an active-passive HA cluster. You
can also configure other HA options, but if you wait until after the cluster is operating
you will only have to configure these options once for the cluster instead of separately
for each unit in the cluster.

6. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose connectivity
with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address of the FortiGate
interfaces. The MAC addresses of the FortiGate interfaces change to the following virtual MAC addresses:
l port1 interface virtual MAC: 00-09-0f-09-00-00
l port2 interface virtual MAC: 00-09-0f-09-00-01
l port3 interface virtual MAC: 00-09-0f-09-00-02
l port4 interface virtual MAC: 00-09-0f-09-00-03

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
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table of your management PC from a command prompt using a command similar to arp -d.

To confirm these MAC address changes, you can use the get hardware nic (or diagnose
hardware deviceinfo nic) CLI command to view the virtual MAC address of any FortiGate
interface. For example, use the following command to view the port1 interface virtual MAC address
(MAC) and the port1 permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
Current_HWaddr: 00:09:0f:09:00:00
Permanent_HWaddr  02:09:0f:78:18:c9
.
.
.

10. Power off the first FortiGate (FGT_ha_1).

Note the details and format of the output of the get hardware nic command are
specific to the interface hardware. Different FortiGate models and even different
interfaces in the same FortiGate may have different output.

To configure the second FortiGate (host name FGT_ha_2)

1. Register and apply licenses to the FortiGate before configuring it for HA operation.
2. Click on the System Information dashboard widget and select Configure settings in System > Settings.
3. Enter a new Host Name for this FortiGate.

New Name FGT_ha_2

4. Select OK.
5. Go to System > HA and change the following settings:

Mode Active-Passive

Group Name example1.com

Password HA_pass_1

6. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and because the FGCP changes the MAC
address of the FortiGate interfaces.

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

7. Power off the second FortiGate.
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To connect the cluster to the network

1. Connect the port1 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
2. Connect the port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal network.
3. Connect the port3 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or

regular Ethernet cables and a switch.
4. Connect the port4 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular

Ethernet cables and a switch.
5. Power on the cluster units.

The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention and normally takes less than a minute.

When negotiation is complete the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view the HA Status dashboard widget and cluster members list to confirm that the
cluster units are operating as a cluster.

Once the cluster is operating, because configuration changes are synchronized to all
cluster units, configuring the cluster is the same as configuring an individual FortiGate.
You could have performed the following configuration steps separately on each
FortiGate before you connected them to form a cluster.

1. Start Internet Explorer and browse to the address https://192.168.1.99 (remember to include the “s” in https://).
The FortiGate Login is displayed.

2. Type admin in the Name field and select Login.
The FortiGate dashboard is displayed.
The HA Status dashboard widget displays how long the cluster has been operating (Uptime) and the
time since the last failover occurred (State Changed). You can hover over the State Changed time to
see the event that caused the state change. You can also click on the HA Status dashboard widget to
configure HA settings or to get a listing of the most recent HA events recorded by the cluster.

3. Go to System > HA to view the cluster members list.
The list shows both cluster units, their host names, their roles in the cluster, and their device priorities.
You can use this list to confirm that the cluster is operating normally. For example, if the list shows
only one cluster unit then the other unit has left the cluster for some reason.

To troubleshoot the cluster configuration

If the cluster members list and the dashboard do not display information for both cluster units, the FortiGates are
not functioning as a cluster. See Troubleshooting HA clusters on page 1845 to troubleshoot the cluster.

To add basic configuration settings to the cluster

Use the following steps to configure the cluster to connect to its network. The following are example configuration
steps only and do not represent all of the steps required to configure the cluster for a given network.

1. Log into the cluster GUI.
2. Go to System > Administrators.
3. Edit admin and select Change Password.
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4. Enter and confirm a new password.
5. Select OK.
6. Go to Network > Interfaces.
7. Edit the port2 interface and change IP/Netmask to 10.11.101.100/24.
8. Select OK.

After changing the IP address of the port1 interface you may have to change the IP
address of your management computer and then reconnect to the port1 interface
using the 172.20.120.141 IP address.

9. Edit the port1 interface and change IP/Netmask to 172.20.120.141/24.
10. Select OK.
11. Go to Network > Static Routes.
12. Change the default route.

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.2

Device port1

Distance 10

13. Select OK.

Configuring a NAT mode active-passive cluster of two FortiGates - CLI

Use the following procedures to configure two FortiGates for NAT HA operation using the FortiGate CLI. These
procedures assume you are starting with two FortiGates with factory default settings.

To configure the first FortiGate (host name FGT_ha_1)

1. Power on the FortiGate.
2. Connect a null modem cable to the communications port of the management computer and to the FortiGate

Console port.
3. Start HyperTerminal (or any terminal emulation program), enter a name for the connection, and select OK.
4. Configure HyperTerminal to connect directly to the communications port on the computer to which you have

connected the null modem cable and select OK.
5. Select the following port settings and select OK.

Bits per second 9600

Data bits 8

Parity None

Stop bits 1

Flow control None
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6. PressEnter to connect to the FortiGate CLI.
The FortiGate CLI login prompt appears.
If the prompt does not appear, press Enter. If it still does not appear, power off your FortiGate and
power it back on. If you are connected, at this stage you will see startup messages that will confirm
you are connected. The login prompt will appear after the startup has completed.

7. Type admin and pressEnter twice.
8. Register and apply licenses to the FortiGate.
9. Change the host name for this FortiGate.

config system global
set hostname FGT_ha_1

end

10. Configure HA settings.
config system ha

set mode a-p
set group-name example1.com
set password HA_pass_1

end

The FortiGate negotiates to establish an HA cluster. You may temporarily lose network connectivity
with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address of the
FortiGate interfaces. The MAC addresses of the FortiGate interfaces change to the following virtual
MAC addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port2 interface virtual MAC: 00-09-0f-09-00-01
l port3 interface virtual MAC: 00-09-0f-09-00-02
l port4 interface virtual MAC: 00-09-0f-09-00-03

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

To confirm these MAC address changes, you can use the get hardware nic (or diagnose
hardware deviceinfo nic) CLI command to view the virtual MAC address of any FortiGate
interface. For example, use the following command to view the port1 interface virtual MAC address
(MAC) and the port1 permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
Current_HAaddr 00:09:0f:09:00:00
Permanent_HWaddr  02:09:0f:78:18:c9
.
.
.

10. Display the HA configuration (optional).
get system ha

group-id : 0
group-name : example1.com
mode : a-p
password : *
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hbdev : "port3" 50 "port4" 50
session-sync-dev :
route-ttl : 10
route-wait : 0
route-hold : 10
sync-config : enable
encryption : disable
authentication : disable
hb-interval : 2
hb-lost-threshold : 20
hello-holddown : 20
arps : 5
arps-interval : 8
session-pickup : disable
update-all-session-timer: disable
session-sync-daemon-number: 1
link-failed-signal : disable
uninterruptible-upgrade: enable
ha-mgmt-status : disable
ha-eth-type : 8890
hc-eth-type : 8891
l2ep-eth-type : 8893
ha-uptime-diff-margin: 300
vcluster2 : disable
vcluster-id : 1
override : disable
priority : 128
slave-switch-standby: disable
minimum-worker-threshold: 1
monitor :
pingserver-monitor-interface:
pingserver-failover-threshold: 0
pingserver-slave-force-reset: enable
pingserver-flip-timeout: 60
vdom : "root"

11. Power off the FortiGate.

To configure the second FortiGate (host name FGT_ha_2)

1. Power on the FortiGate.
2. Connect a null modem cable to the communications port of the management computer and to the FortiGate

Console port.
3. Start HyperTerminal, enter a name for the connection, and select OK.
4. Configure HyperTerminal to connect directly to the communications port on the computer to which you have

connected the null modem cable and select OK.
5. Select the following port settings and select OK.

Bits per second 9600

Data bits 8

Parity None

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1786



FGCP configuration examples and troubleshooting Chapter 15 - High Availability

Stop bits 1

Flow control None

6. PressEnter to connect to the FortiGate CLI.
The FortiGate CLI login prompt appears.

7. Type admin and pressEnter twice.
8. Register and apply licenses to the FortiGate.
9. You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the

cluster is formed third-party certificates are synchronized to the backup FortiGate.
FortiToken licenses can be added at any time because they are synchronized to all cluster members.

10. Change the host name for this FortiGate.
config system global

set hostname FGT_ha_2
end

11. Configure HA settings.
config system ha

set mode a-p
set group-name example1.com
set password HA_pass_1

end

The FortiGate negotiates to establish an HA cluster. You may temporarily lose network connectivity
with the FortiGate as the HA cluster negotiates and because the FGCP changes the MAC address of
the FortiGate interfaces.

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

12. Display the HA configuration (optional).
get system ha

group-id : 0
group-name : example1.com
mode : a-p
password : *
hbdev : "port3" 50 "port4" 50
session-sync-dev :
route-ttl : 10
route-wait : 0
route-hold : 10
sync-config : enable
encryption : disable
authentication : disable
hb-interval : 2
hb-lost-threshold : 20
hello-holddown : 20
arps : 5
arps-interval : 8
session-pickup : disable
update-all-session-timer: disable
session-sync-daemon-number: 1
link-failed-signal : disable
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uninterruptible-upgrade: enable
ha-mgmt-status : disable
ha-eth-type : 8890
hc-eth-type : 8891
l2ep-eth-type : 8893
ha-uptime-diff-margin: 300
vcluster2 : disable
vcluster-id : 1
override : disable
priority : 128
slave-switch-standby: disable
minimum-worker-threshold: 1
monitor :
pingserver-monitor-interface:
pingserver-failover-threshold: 0
pingserver-slave-force-reset: enable
pingserver-flip-timeout: 60
vdom : "root"

13. Power off the FortiGate.

To connect the cluster to the network

1. Connect the port1 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
2. Connect the port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal network.
3. Connect the port3 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or

regular Ethernet cables and a switch.
4. Connect the port4 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular

Ethernet cables and a switch.
5. Power on the cluster units.

The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention and normally takes less than a minute.

When negotiation is complete the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view cluster status from the CLI.

1. Determine which cluster unit is the primary unit.
l Use the null-modem cable and serial connection to re-connect to the CLI of one of the cluster units.
l Enter the command get system status.
l If the command output includes Current HA mode: a-p, master, the cluster units are operating as a

cluster and you have connected to the primary unit. Continue with Step "Setting up two new FortiGates as an
FGCP cluster" on page 1778.

l If the command output includes Current HA mode: a-p, backup, you have connected to a subordinate
unit. Connect the null-modem cable to the other cluster unit, which should be the primary unit and continue
with Step 2.

If the command output includes Current HA mode: standalone, the cluster
unit is not operating in HAmode and you should review your HA configuration.
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2. Enter the following command to confirm the HA configuration of the cluster:

get system ha status
HA Health Status: OK
Model: FortiGate-XXXX
Mode: HA A-P
Group: 0
Debug: 0
Cluster Uptime: 7 days 00:30:26
.
.
.

You can use this command to confirm that the cluster is healthy and operating normally, some
information about the cluster configuration, and information about how long the cluster has been
operating. Information not shown in this example includes how the primary unit was selected,
configuration synchronization status, usage stats for each cluster unit, heartbeat status, and the
relative priorities of the cluster units.

.

3. Check the cluster synchronization status to make sure the primary and backup units have the same configuration. Log
into the primary unit CLI and enter this command:

diagnose sys ha checksum show

The CLI lists all members' checksums. If both cluster units have identical checksums you can be sure that their
configurations are synchronized. If the checksums are different wait a short while and enter the command again.
Repeat until the checksums are identical. It may take a while for some parts of the configuration to be synchronized. If
the checksums never become identical visit the Fortinet Support website to find help troubleshooting the problem.

To troubleshoot the cluster configuration

If the cluster members list and the dashboard do not display information for both cluster units the FortiGates are
not functioning as a cluster. See Troubleshooting HA clusters on page 1845 to troubleshoot the cluster.

To add basic configuration settings to the cluster

Use the following steps to add some basic settings to the cluster so that it can connect to the network.

1. Log into the primary unit CLI.
2. Add a password for the admin administrative account.

config system admin
edit admin

set password <password_str>
end

3. Configure the port1 and port2 interfaces.
config system interface

edit port1
set ip 172.20.120.141/24

next
edit port2

set ip 10.11.101.100/24
end
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4. Add a default route.
config router static

edit 1
set dst 0.0.0.0 0.0.0.0
set gateway 172.20.120.2
set device port1

end

Adding a new FortiGate to an operating cluster
This procedure describes how to add a new FortiGate to a functioning cluster. Adding a new unit to a cluster does
not interrupt the operation of the cluster unless you have to change how the cluster is connected to the network to
accommodate the new cluster unit.

You can use this procedure to add as many units as required to the cluster.

To add a new unit to a functioning cluster

1. Install the same firmware build on the new cluster unit as is running on the cluster.
2. Register and apply licenses to the primary FortiGate before configuring it for HA operation. This includes licensing

for FortiCare Support, IPS, AntiVirus, Web Filtering, Mobile Malware, FortiClient, FortiCloud, and
additional virtual domains (VDOMs). All FortiGates in the cluster must have the same level of licensing for
FortiGuard, FortiCloud, FortiClient, and VDOMs. FortiToken licenses can be added at any time because they are
synchronized to all cluster members.

If the FortiGates in the cluster will be running FortiOS Carrier, apply the FortiOS Carrier license before configuring
the cluster (and before applying other licenses). Applying the FortiOS Carrier license sets the configuration to
factory defaults, requiring you to repeat steps performed before applying the license.

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed, third-party certificates are synchronized to the backup FortiGate.

3. Configure the new cluster unit for HA operation with the same HA configuration as the other units in the cluster.
4. If the cluster is running in transparent mode, change the operating mode of the new cluster unit to transparent

mode.
5. Power off the new cluster unit.
6. Connect the new cluster unit to the cluster.
7. For example, see How to set up FGCP clustering (recommended steps) on page 1771.
8. Power on the new cluster unit.

When the unit starts it negotiates to join the cluster. After it joins the cluster, the cluster synchronizes
the new unit configuration with the configuration of the primary unit.

You can add a new unit to a functioning cluster at any time. For best results the new cluster unit should:

l Have the same hardware version as the cluster units.
l Have the same firmware build as the cluster.
l Be set to the same operating mode (NAT or transparent) as the cluster.
l Be operating in single VDOM mode.
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Active-active HA cluster in transparent mode
This section describes a simple HA network topology that includes an HA cluster of two generic FortiGates
installed between an internal network and the Internet and running in transparent mode.

Example transparent mode HA network topology

The figure below shows a transparent mode FortiGate HA cluster consisting of two FortiGates (FGT_ha_1 and
FGT_ha_2) installed between the Internet and internal network. The topology includes a router that performs
NAT between the internal network and the Internet. The cluster management IP address is 10.11.101.100.

Transparent mode HA network topology

Port3 and port4 are used as the heartbeat interfaces. Because the cluster consists of two FortiGates, you can
make the connections between the heartbeat interfaces using crossover cables. You could also use switches and
regular Ethernet cables.

General configuration steps

This section includes GUI and CLI procedures. These procedures assume that the FortiGates are running the
same FortiOS firmware build and are set to the factory default configuration.

In this example, the configuration steps are identical to the NAT mode configuration steps until the cluster is
operating. When the cluster is operating, you can switch to transparent mode and add basic configuration
settings to cluster.
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General configuration steps

1. Apply licenses to the FortiGates to become the cluster.
2. Configure the FortiGates for HA operation.

l Optionally change each unit’s host name.
l Configure HA.

2. Connect the cluster to the network.
3. Confirm that the cluster units are operating as a cluster.
4. Switch the cluster to transparent mode and add basic configuration settings to the cluster.

l Switch to transparent mode, add the management IP address and a default route.
l Add a password for the admin administrative account.
l View cluster status from the GUI or CLI.

Configuring a transparent mode active-active cluster of two FortiGates - GUI

Use the following procedures to configure the FortiGates for HA operation using the FortiGate GUI. These
procedures assume you are starting with two FortiGates with factory default settings.

Waiting until you have established the cluster to switch to transparent mode means
fewer configuration steps because you can switch the mode of the cluster in one step.

To configure the first FortiGate (host name FGT_ha_1)

1. Register and apply licenses to the FortiGate before configuring it for HA operation. This includes licensing for
FortiCare Support, IPS, AntiVirus, Web Filtering, Mobile Malware, FortiClient, FortiCloud, and
additional virtual domains (VDOMs). All FortiGates in the cluster must have the same level of licensing for
FortiGuard, FortiCloud, FortiClient, and VDOMs. FortiToken licenses can be added at any time because they are
synchronized to all cluster members.

If the FortiGates in the cluster will be running FortiOS Carrier, apply the FortiOS Carrier license before configuring
the cluster (and before applying other licenses). Applying the FortiOS Carrier license sets the configuration to
factory defaults, requiring you to repeat steps performed before applying the license.

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed, third-party certificates are synchronized to the backup FortiGate.
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2. Click on the System Information dashboard widget and select Configure settings in System > Settings.
3. Enter a new Host Name for this FortiGate.

New Name FGT_ha_1

4. Select OK.
5. Go to System > HA and change the following settings:

Mode Active-Active

Group Name example2.com

Password HA_pass_2

This is the minimum recommended configuration for an active-active HA cluster. You
can configure other HA options at this point, but if you wait until the cluster is operating
you will only have to configure these options once for the cluster instead of separately
for each cluster unit.

6. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address
of the FortiGate interfaces. The MAC addresses of the FortiGate interfaces change to the following
virtual MAC addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port2 interface virtual MAC: 00-09-0f-09-00-01
l port3 interface virtual MAC: 00-09-0f-09-00-02
l port4 interface virtual MAC: 00-09-0f-09-00-03
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To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

To confirm these MAC address changes, you can use the get hardware nic (or diagnose
hardware deviceinfo nic) CLI command to view the virtual MAC address of any FortiGate
interface. For example, use the following command to view the port1 interface virtual MAC address
(MAC) and the port1 permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
Current_HAaddr 00:09:0f:09:00:00
Permanent_HWaddr  02:09:0f:78:18:c9
.
.
.

10. Power off the first FortiGate.

To configure the second FortiGate (host name FGT_ha_2)

1. Register and apply licenses to the FortiGate before configuring it for HA operation.

2. Click on the System Information dashboard widget and select Configure settings in System > Settings.
3. Enter a new Host Name for this FortiGate.

New Name FGT_ha_2

4. Select OK.
5. Go to System > HA and change the following settings:
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Mode Active-Active

Group Name example2.com

Password HA_pass_2

6. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and because the FGCP changes the MAC
address of the FortiGate interfaces.

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

7. Power off the second FortiGate.

To connect the cluster to the network

1. Connect the port1 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
2. Connect the port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal network.
3. Connect the port3 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or

regular Ethernet cables and a switch.
4. Connect the port4 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular

Ethernet cables and a switch.
5. Power on the cluster units.

The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention and normally takes less than a minute.

When negotiation is complete the cluster is ready to be configured for your network.

To switch the cluster to transparent mode

Switching from NAT to transparent mode involves adding the transparent mode management IP address and
default route.

This is the minimum recommended configuration for an active-active HA cluster. You
can configure other HA options at this point, but if you wait until the cluster is operating
you will only have to configure these options once for the cluster instead of separately
for each cluster unit.

1. Start a web browser and browse to the address https://192.168.1.99 (remember to include the “s” in
https://).
The FortiGate Login is displayed.

2. Type admin in the Name field and select Login.
3. Under System Information, besideOperation Mode select Change.
4. Set Operation Mode to transparent.
5. Configure basic transparent mode settings.
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Operation Mode Transparent

Management IP/Mask 10.11.101.100/24

Default Gateway 10.11.101.2

6. Select Apply.
The cluster switches to operating in transparent mode. The virtual MAC addresses assigned to the
cluster interfaces do not change.

To view cluster status

Use the following steps to view the cluster dashboard and cluster members list to confirm that the cluster units
are operating as a cluster.

Once the cluster is operating, because configuration changes are synchronized to all
cluster units, configuring the cluster is the same as configuring an individual FortiGate.
You could have performed the following configuration steps separately on each
FortiGate before you connected them to form a cluster.

1. Start Internet Explorer and browse to the address https://10.11.101.100 (remember to include the “s” in https://).
The FortiGate Login is displayed.

2. Type admin in the Name field and select Login.
The FortiGate dashboard is displayed.

The HA Status dashboard widget displays how long the cluster has been operating (Uptime) and the
time since the last failover occurred (State Changed). You can hover over the State Changed time to
see the event that caused the state change. You can also click on the HA Status dashboard widget to
configure HA settings or to get a listing of the most recent HA events recorded by the cluster.

3. Go to System > HA to view the cluster members list.
The list shows both cluster units, their host names, their roles in the cluster, and their device priorities.
You can use this list to confirm that the cluster is operating normally. For example, if the list shows
only one cluster unit then the other unit has left the cluster for some reason.

To troubleshoot the cluster configuration

If the cluster members list and the dashboard do not display information for both cluster units, the FortiGates are
not functioning as a cluster. See Troubleshooting HA clusters on page 1845 to troubleshoot the cluster.

To add basic configuration settings to the cluster

Use the following steps to configure the cluster. Note that the following are example configuration steps only and
do not represent all of the steps required to configure the cluster for a given network.

1. Log into the cluster GUI.
2. Go to System > Administrators.
3. Edit admin and select Change Password.
4. Enter and confirm a new password.
5. Select OK.
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You added a default gateway when you switched to transparent mode so you don’t
need to add a default route as part of the basic configuration of the cluster at this
point.

Configuring a transparent mode active-active cluster of two FortiGates - CLI

Use the following procedures to configure the FortiGates for transparent mode HA operation using the FortiGate
CLI.

To configure each FortiGate for HA operation

1. Power on the FortiGate.
2. Connect a null modem cable to the communications port of the management computer and to the FortiGate

Console port.
3. Start HyperTerminal, enter a name for the connection, and select OK.
4. Configure HyperTerminal to connect directly to the communications port on the computer to which you have

connected the null modem cable and select OK.
5. Select the following port settings and select OK.

Bits per second 9600

Data bits 8

Parity None

Stop bits 1

Flow control None

6. PressEnter to connect to the FortiGate CLI.
The FortiGate CLI login prompt appears.If the prompt does not appear, press Enter. If it still does not
appear, power off your FortiGate and power it back on. If you are connected, at this stage you will see
startup messages that will confirm you are connected. The login prompt will appear after the startup
has completed.

7. Type admin and pressEnter twice.
8. Register and apply licenses to the FortiGate.
9. Change the host name for this FortiGate. For example:

config system global
set hostname FGT_ha_1

end

10. Configure HA settings.
config system ha

set mode a-a
set group-name example2.com
set password HA_pass_2

end
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This is the minimum recommended configuration for an active-active HA cluster. You
can also configure other HA options, but if you wait until after the cluster is operating
you will only have to configure these options once for the cluster instead of separately
for each cluster unit.

The FortiGate negotiates to establish an HA cluster. You may temporarily lose network connectivity
with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address of the
FortiGate interfaces. The MAC addresses of the FortiGate interfaces change to the following virtual
MAC addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port2 interface virtual MAC: 00-09-0f-09-00-01
l port3 interface virtual MAC: 00-09-0f-09-00-02
l port4 interface virtual MAC: 00-09-0f-09-00-03

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

To confirm these MAC address changes, you can use the get hardware nic (or diagnose
hardware deviceinfo nic) CLI command to view the virtual MAC address of any FortiGate
interface. For example, use the following command to view the port1 interface virtual MAC address
(MAC) and the port1 permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
Current_HAaddr 00:09:0f:09:00:00
Permanent_HWaddr  02:09:0f:78:18:c9
.
.
.

10. Display the HA configuration (optional).
get system ha

group-id : 0
group-name : example2.com
mode : a-a
password : *
hbdev : "port3" 50 "port4" 50
session-sync-dev :
route-ttl : 10
route-wait : 0
route-hold : 10
sync-config : enable
encryption : disable
authentication : disable
hb-interval : 2
hb-lost-threshold : 20
hello-holddown : 20
arps : 5
arps-interval : 8
session-pickup : disable
update-all-session-timer: disable
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session-sync-daemon-number: 1
link-failed-signal : disable
uninterruptible-upgrade: enable
ha-mgmt-status : disable
ha-eth-type : 8890
hc-eth-type : 8891
l2ep-eth-type : 8893
ha-uptime-diff-margin: 300
vcluster2 : disable
vcluster-id : 1
override : disable
priority : 128
slave-switch-standby: disable
minimum-worker-threshold: 1
monitor :
pingserver-monitor-interface:
pingserver-failover-threshold: 0
pingserver-slave-force-reset: enable
pingserver-flip-timeout: 60
vdom : "root"

11. Power off the FortiGate.

To configure the second FortiGate (host name FGT_ha_2)

1. Power on the FortiGate.
2. Connect a null modem cable to the communications port of the management computer and to the FortiGate

Console port.
3. Start HyperTerminal, enter a name for the connection, and select OK.
4. Configure HyperTerminal to connect directly to the communications port on the computer to which you have

connected the null modem cable and select OK.
5. Select the following port settings and select OK.

Bits per second 9600

Data bits 8

Parity None

Stop bits 1

Flow control None

6. PressEnter to connect to the FortiGate CLI.
The FortiGate CLI login prompt appears.If the prompt does not appear, press Enter. If it still does not
appear, power off your FortiGate and power it back on. If you are connected, at this stage you will see
startup messages that will confirm you are connected. The login prompt will appear after the startup
has completed.

7. Type admin and pressEnter twice.
8. Register and apply licenses to the FortiGate.
9. Change the host name for this FortiGate.

config system global
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set hostname FGT_ha_2
end

10. Configure HA settings.
config system ha

set mode a-a
set group-name example2.com
set password HA_pass_2

end

The FortiGate negotiates to establish an HA cluster. You may temporarily lose network connectivity
with the FortiGate as the HA cluster negotiates and because the FGCP changes the MAC address of
the FortiGate interfaces.

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

11. Display the HA configuration (optional).
get system ha

group-id : 0
group-name : example2.com
mode : a-a
password : *
hbdev : "port3" 50 "port4" 50
session-sync-dev :
route-ttl : 10
route-wait : 0
route-hold : 10
sync-config : enable
encryption : disable
authentication : disable
hb-interval : 2
hb-lost-threshold : 20
hello-holddown : 20
arps : 5
arps-interval : 8
session-pickup : disable
update-all-session-timer: disable
session-sync-daemon-number: 1
link-failed-signal : disable
uninterruptible-upgrade: enable
ha-mgmt-status : disable
ha-eth-type : 8890
hc-eth-type : 8891
l2ep-eth-type : 8893
ha-uptime-diff-margin: 300
vcluster2 : disable
vcluster-id : 1
override : disable
priority : 128
schedule : round-robin
monitor :
pingserver-monitor-interface:
pingserver-failover-threshold: 0
pingserver-slave-force-reset: enable
pingserver-flip-timeout: 60
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vdom : "root"
schedule : round-robin

12. Power off the FortiGate.

To connect the cluster to the network

1. Connect the port1 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
2. Connect the port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal network.
3. Connect the port3 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or

regular Ethernet cables and a switch.
4. Connect the port4 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular

Ethernet cables and a switch.
5. Power on the cluster units.

The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention and normally takes less than a minute.

When negotiation is complete the cluster is ready to be configured for your network.

To connect to the cluster CLI and switch the cluster to transparent mode

1. Determine which cluster unit is the primary unit.
l Use the null-modem cable and serial connection to re-connect to the CLI of one of the cluster units.
l Enter the command get system status.
l If the command output includes Current HA mode: a-a, master, the cluster units are operating as a

cluster and you have connected to the primary unit. Continue with Step 2.
l If the command output includes Current HA mode: a-a, backup, you have connected to a subordinate

unit. Connect to the other cluster unit, which should be the primary unit and continue with Step 2.

If the command output includes Current HA mode: standalone, the cluster
unit is not operating in HAmode.

2. Change to transparent mode.
config system settings

set opmode transparent
set manageip 192.168.20.3/24
set gateway 192.168.20.1

end

The cluster switches to transparent Mode, and your administration session is disconnected.

You can now connect to the cluster CLI using SSH to connect to the cluster internal interface using the
management IP address (192.168.20.3).

To view cluster status

Use the following steps to view cluster status from the CLI.

1. Determine which cluster unit is the primary unit.
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l Use the null-modem cable and serial connection to re-connect to the CLI of one of the cluster units.
l Enter the command get system status.
l If the command output includes Current HA mode: a-a, master, the cluster units are operating as a

cluster and you have connected to the primary unit. Continue with Step "Active-active HA cluster in transparent
mode" on page 1791.

l If the command output includes Current HA mode: a-a, backup, you have connected to a subordinate
unit. Connect the null-modem cable to the other cluster unit, which should be the primary unit and continue
with Step 2.

If the command output includes Current HA mode: standalone, the cluster
unit is not operating in HAmode and you should review your HA configuration.

2. Enter the following command to confirm the HA configuration of the cluster:

get system ha status
HA Health Status: OK
Model: FortiGate-XXXX
Mode: HA A-P
Group: 0
Debug: 0
Cluster Uptime: 7 days 00:30:26
.
.
.

You can use this command to confirm that the cluster is healthy and operating normally, some
information about the cluster configuration, and information about how long the cluster has been
operating. Information not shown in this example includes how the primary unit was selected,
configuration synchronization status, usage stats for each cluster unit, heartbeat status, and the
relative priorities of the cluster units.

To troubleshoot the cluster configuration

If the cluster members list and the dashboard do not display information for both cluster units the FortiGates are
not functioning as a cluster. See Troubleshooting HA clusters on page 1845 to troubleshoot the cluster.

To add a password for the admin administrative account

1. Add a password for the admin administrative account.
config system admin

edit admin
set password <psswrd>

end

FortiGate-5000 active-active HA cluster with FortiClient licenses
This section describes how to configure an HA cluster of three FortiGate-5001D units that connect an internal
network to the Internet. The FortiGate-5001D units each have a FortiClient license installed on them to support
FortiClient profiles.
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Normally it is recommended that you add FortiClient licenses to the FortiGates before setting up the cluster. This
example; however, describes how to apply FortiClient licenses to the FortiGates in an operating cluster.

Example network topology

The following diagram shows an HA cluster consisting of three FortiGate-5001D cluster units (host names slot-3,
slot-4, and slot-5) installed in a FortiGate-5000 series chassis with two FortiController-5003B units for heartbeat
communication between the cluster units. The cluster applies security features including FortiClient profiles to
data traffic passing through it.

The cluster is managed from the internal network using the FortiGate-5001D mgmt1 interfaces configured as HA
reserved management interfaces. Using these reserved management interfaces the overall cluster can be
managed and cluster units can be managed individually. Individual management access to each cluster unit
makes some operations, such as installing FortiClient licenses, easier and also allows you to view status of each
cluster unit.

The reserved management interface of each cluster unit has a different IP address and retains its own MAC
address. The cluster does not change the reserved management interface MAC address.

Example network topology

By default base1 and base2 are used for heartbeat communication between the FortiGates. To use the base1
and base2 interfaces for the HA heartbeat, the example describes how to display the backplane interfaces on the
GUI before turning on HA.
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This example also includes using the mgmt2 interface for heartbeat communication for additional heartbeat
redundancy.

To connect the cluster

1. Connect the FortiGate-5001D port1 interfaces to a switch and connect that switch to the Internet.
2. Connect the FortiGate-5001D port2 interfaces to a switch and connect that switch to the internal network.
3. Connect the FortiGate-5001D mgmt1 interfaces to a switch that connects to the engineering network.
4. Connect the FortiGate-5001D mgmt2 interfaces to a switch for heartbeat communication between them.

Configuring the FortiGate-5000 active-active cluster - GUI

These procedures assume you are starting with three FortiGate-5001D boards and two FortiSwitch-5003B boards
installed in a compatible FortiGate-5000 series chassis. The FortiSwitch-5003B boards are in chassis slots 1 and
2 and the FortiGate-5001D boards are in chassis slots 3, 4, and 5 and the chassis is powered on. All devices are
in their factory default configuration. No configuration changes to the FortiSwitch-5003B boards are required.

To configure the FortiGate-5001D units

1. From the internal network, log into the GUI of the FortiGate-5001D unit in chassis slot 3 by connecting to the
mgmt1 interface.

By default the mgmt1 interface of each FortiGate-5001D unit has the same IP
address. To log into each FortiGate-5001D unit separately you could either disconnect
the mgmt1 interfaces of the units that you don’t want to log into or change the mgmt1
interface IP addresses for each unit by connecting to each unit’s CLI from their console
port.

2. Register and apply licenses to the FortiGate before configuring it for HA operation. This includes licensing for
FortiCare Support, IPS, AntiVirus, Web Filtering, Mobile Malware, FortiCloud, and additional virtual
domains (VDOMs). All FortiGates in the cluster must have the same level of licensing for FortiGuard, FortiCloud,
FortiClient, and VDOMs. FortiToken licenses can be added at any time because they are synchronized to all
cluster members. FortiClient licenses will be added in a following step.

If the FortiGates in the cluster will be running FortiOS Carrier, apply the FortiOS Carrier license before configuring
the cluster (and before applying other licenses). Applying the FortiOS Carrier license sets the configuration to
factory defaults, requiring you to repeat steps performed before applying the license.

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed, third-party certificates are synchronized to the backup FortiGate.
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3. Click on the System Information dashboard widget and select Configure settings in System > Settings.
4. Enter a new Host Name for this FortiGate, for example:

New Name 5001D-Slot-3

5. Connect to the CLI and enter the following command to display backplane interfaces on the GUI:
config system global

set show-backplane-intf enable
end

6. Set the Administrative Status of the base1 and base 2 interfaces to Up.
You can do this from the GUI by going to Network > Interfaces, editing each interface and setting
Administrative Status to Up.

You can also do this from the CLI using the following command:

config system interface
edit base1

set status up
next
edit base2

set status up
end

7. Go to Network > Interfaces and configure the IP address of the mgmt1 interface.
Because mgmt1 will become the reserved management interface for the cluster unit each FortiGate-
5001D should have a different mgmt1 interface IP address. Give the mgmt1 interface an address that
is valid for the internal network. Once HAwith the reserved Management interface is enabled the IP
address of the mgmt1 interface can be on the same subnet as the port2 interface (which will also be
connected to the Internal network).

After the FortiGate is operating in HAmode the mgmt1 interface will retain its original MAC address
instead of being assigned a virtual MAC address.
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8. Go to System > HA and change the following settings:
Set theMode to Active-Active.

Select Reserve Management Port for Cluster Member and selectmgmt1.

Set the group name and password:

Group Name example3.com

Password HA_pass_3

Set the Heartbeat interface configuration to use base1, base2 and mgmt2 for heartbeat
communication. Set the priority of each heartbeat interface to 50:

Heartbeat Interface

Enable Priority

base1 Select 50

base2 Select 50

mgmt2 Select 50

9. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address
of the FortiGate interfaces. The MAC addresses of the FortiGate-5001D interfaces change to the
following virtual MAC addresses:

l base1 interface virtual MAC: 00-09-0f-09-00-00
l base2 interface virtual MAC: 00-09-0f-09-00-01
l fabric1 interface virtual MAC: 00-09-0f-09-00-02
l fabric2 interface virtual MAC: 00-09-0f-09-00-03
l fabric3 interface virtual MAC: 00-09-0f-09-00-04
l fabric4 interface virtual MAC: 00-09-0f-09-00-05
l fabric5 interface virtual MAC: 00-09-0f-09-00-06
l mgmt1 keeps its original MAC address
l mgmt2 interface virtual MAC: 00-09-0f-09-00-08
l port1 interface virtual MAC: 00-09-0f-09-00-09
l port2 interface virtual MAC: 00-09-0f-09-00-0a

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic base1
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.

.

.
Current_HWaddr 00:09:0f:09:00:00
Permanent_HWaddr 00:09:0f:71:0a:dc
.
.
.

9. Repeat these steps for the FortiGate-5001D units in chassis slots 4 and 5, with the following differences.
Set the mgmt1 interface IP address of each FortiGate-5001D unit to a different IP address.

Set the FortiGate-5001D unit in chassis slot 4 host name to:

New Name 5001D-Slot-4

Set the FortiGate-5001D unit in chassis slot 5 host name to:

New Name 5001D-Slot-5

As you configure each FortiGate, they will negotiate and join the cluster.

To view cluster status

As you add units to the cluster you can log into the GUI of one of the cluster units to view the status of the cluster.
The status displays will show each unit as it is added to the cluster.

1. Log into the primary unit or any cluster unit and view the system dashboard.
The HA Status dashboard widget displays how long the cluster has been operating (Uptime) and the
time since the last failover occurred (State Changed) You can hover over the State Changed time to
see the event that caused the state change. You can also click on the HA Status dashboard widget to
configure HA settings or to get a listing of the most recent HA events recorded by the cluster.

2. Go to System > HA to view the cluster members list.
The list shows both cluster units, their host names, their roles in the cluster, and their device priorities.
You can use this list to confirm that the cluster is operating normally. For example, if the list shows
only one cluster unit then the other unit has left the cluster for some reason.

To troubleshoot the cluster

See Troubleshooting HA clusters on page 1845.

To manage each cluster unit

Because you have configured a reserved management interface, you can manage each cluster unit separately by
connecting to the IP address you configured for each unit’s mgmt1 interface. You can view the status of each
cluster unit and make changes to each unit’s configuration. For example, as described below, each cluster unit
must have its own FortiClient license. You can use the reserved management IP addresses to connect to each
cluster unit to install the FortiClient license for that unit.

Usually you would make configuration changes by connecting to the primary unit and changing its configuration.
The cluster then synchronizes the configuration changes to all cluster units. If you connect to individual cluster
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units and change their configuration, those configuration changes are also synchronized to each cluster unit. The
exception to this is configuration objects that are not synchronized, such as the host name, FortiClient license
and so on.

You can also manage each cluster unit by logging into the primary unit CLI and using the following command to
connect to other cluster units:

execute ha manage <cluster-index>

To add basic configuration settings to the cluster

Use the following steps to configure the cluster.

1. Log into the cluster GUI.
You can log into the primary unit or any one of the cluster units using the appropriate mgmt1 IP
address.

2. Go to System > Administrators.
3. Edit admin and select Change Password.
4. Enter and confirm a new password.
5. Select OK.
6. Go to Network > Interfaces and edit the port1 interface. Set this interface IP address to the address required to

connect to the interface to the Internet.
7. Edit the port2 interface and set its IP to an IP address for the internal network.

To add a FortiClient license to each cluster unit

Normally you would add FortiClient licenses to the FortiGates before forming the cluster. However, you can use
the following steps to add FortiClient licenses to an operating cluster.

Contact your reseller to purchase FortiClient licenses for your cluster units. Each cluster unit must have its own
FortiClient license.

When you receive the license keys you can log into https://support.fortinet.com and add a FortiClient license key
to each licensed FortiGate. Then, as long as the cluster can connect to the Internet the license keys are
downloaded from the FortiGuard network to all of the FortiGates in the cluster.

You can also use the following steps to manually add the license keys to your cluster units from the GUI. Your
cluster must be connected to the Internet.

1. Log into the GUI of each cluster unit using its reserved management interface IP address.
2. Go to the License Information dashboard widget and beside FortiClient select Enter License.
3. Enter the license key and select OK.
4. Confirm that the license has been installed and the correct number of FortiClients are licensed.
5. Repeat for all of the cluster units.
You can also use the following command to add the license key from the CLI:

execute FortiClient-NAC update-registration-license <license-number>

You can connect to the CLIs of each cluster unit using their reserved management IP address.

You can also log into the primary unit CLI and use the execute ha manage command to connect to each
cluster unit CLI.
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Configuring the FortiGate-5000 active-active cluster - CLI

These procedures assume you are starting with three FortiGate-5001D boards and two FortiSwitch-5003B boards
installed in a compatible FortiGate-5000 series chassis. The FortiSwitch-5003B boards are in chassis slots 1 and
2 and the FortiGate-5001D boards are in chassis slots 3, 4, and 5 and the chassis is powered on. All devices are
in their factory default configuration. No configuration changes to the FortiSwitch-5003B boards are required.

To configure the FortiGate-5005FA2 units

1. From the internal network, log into the CLI of the FortiGate-5001D unit in chassis slot 3 by connecting to the
mgmt1 interface.

By default the mgmt1 interface of each FortiGate-5001D unit has the same IP
address. To log into each FortiGate-5001D unit separately you could either disconnect
the mgmt1 interfaces of the units that you don’t want to log into or change the mgmt1
interface IP addresses for each unit by connecting to each unit’s CLI from their console
port.

You can also use a console connection.

2. Register and apply licenses to the FortiGate.
3. Change the host name for this FortiGate. For example:

config system global
set hostname 5001D-Slot-3

end

4. Enter the following command to display backplane interfaces on the GUI:
config system global

set show-backplane-intf enable
end

5. Set the Administrative Status of the base1 and base 2 interfaces to Up.
config system interface

edit base1
set status up

next
edit base2

set status up
end

6. Add an IP address to the mgmt1 interface.
config system interface

edit mgmt1
set ip 172.20.120.110/24
set allowaccess http https ssl ping

end

Because mgmt1 will become the reserved management interface for the cluster unit each FortiGate-
5001D should have a different mgmt1 interface IP address. Give the mgmt1 interface an address that
is valid for the internal network. Once HAwith the reserved Management interface is enabled the IP
address of the mgmt1 interface can be on the same subnet as the port2 interface (which will also be
connected to the Internal network).

7. Configure HA settings.
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config system ha
set mode a-a
set ha-mgmt-status enable
set ha-mgmt-interface mgmt1
set group-name example3.com
set password HA_pass_3
set hbdev base1 50 base2 50 mgmt2 50

end

The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address
of the FortiGate interfaces. The MAC addresses of the FortiGate-5001D interfaces change to the
following virtual MAC addresses:

l base1 interface virtual MAC: 00-09-0f-09-00-00
l base2 interface virtual MAC: 00-09-0f-09-00-01
l fabric1 interface virtual MAC: 00-09-0f-09-00-02
l fabric2 interface virtual MAC: 00-09-0f-09-00-03
l fabric3 interface virtual MAC: 00-09-0f-09-00-04
l fabric4 interface virtual MAC: 00-09-0f-09-00-05
l fabric5 interface virtual MAC: 00-09-0f-09-00-06
l mgmt1 keeps its original MAC address
l mgmt2 interface virtual MAC: 00-09-0f-09-00-08
l port1 interface virtual MAC: 00-09-0f-09-00-09
l port2 interface virtual MAC: 00-09-0f-09-00-0a

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic base1
.
.
.
Current_HWaddr 00:09:0f:09:00:00
Permanent_HWaddr 00:09:0f:71:0a:dc
.
.
.

7. Repeat these steps for the FortiGate-5001D units in chassis slots 4 and 5, with the following differences.
Set the mgmt1 interface IP address of each FortiGate-5001D unit to a different IP address.

Set the FortiGate-5001D unit in chassis slot 4 host name to:

config system global
set hostname 5001D-Slot-4

end

Set the FortiGate-5001D unit in chassis slot 5 host name to:
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config system global
set hostname 5001D-Slot-5

end

As you configure each FortiGate, they will negotiate and join the cluster.

To view cluster status

As you add units to the cluster you can log into the CLI of one of the cluster units using its reserved management
interface to view the status of the cluster. The status will show each unit as it is added to the cluster.

For example, the following command output shows the status of the cluster when all three cluster units have
been added:

get system ha status
HA Health Status: OK
Model: FortiGate-XXXX
Mode: HA A-P
Group: 0
Debug: 0
Cluster Uptime: 7 days 00:30:26
.
.
.
Slave : 5001d-slot4 , FG-5KD3914800284, operating cluster index = 2
Master: 5001d-slot5 , FG-5KD3914800353, operating cluster index = 0
Slave : 5001d-slot3 , FG-5KD3914800344, operating cluster index = 1

You can use this command to confirm that the cluster is healthy and operating normally, some information about
the cluster configuration, and information about how long the cluster has been operating. Information not shown
in this example includes how the primary unit was selected, configuration synchronization status, usage stats for
each cluster unit, heartbeat status, and the relative priorities of the cluster units.

To troubleshoot the cluster

See Troubleshooting HA clusters on page 1845.

To manage each cluster unit

Because you have configured a reserved management interface, you can manage each cluster unit separately by
connecting to the IP address you configured for each unit’s mgmt1 interface. You can view the status of each
cluster unit and make changes to each unit’s configuration. For example, as described below, each cluster unit
must have its own FortiClient license. You can use the reserved management IP addresses to connect to each
cluster unit to install the FortiClient license for that unit.

Usually you would make configuration changes by connecting to the primary unit and changing its configuration.
The cluster then synchronizes the configuration changes to all cluster units. If you connect to individual cluster
units and change their configuration, those configuration changes are also synchronized to each cluster unit. The
exception to this is configuration objects that are not synchronized, such as the host name, FortiClient license
and so on.

You can also manage each cluster unit by logging into the primary unit CLI and using the following command to
connect to other cluster units:

execute ha manage <cluster-index>
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To add a password for the admin administrative account

1. Add a password for the admin administrative account.
config system admin

edit admin
set password <psswrd>

end

To add basic configuration settings to the cluster

Use the following steps to configure the cluster.

1. Log into the cluster CLI.
You can log into the primary unit or any one of the cluster units using the appropriate mgmt1 IP
address.

2. Add a password for the admin administrative account.
config system admin

edit admin
set password <psswrd>

end

3. Set the port1 interface IP address to the address required to connect to the interface to the Internet.
config system interface

edit port1
set ip 10.10.10.10/24

end

4. Set the port2 interface IP address to the address required to connect to the interface to the internal network.
config system interface

edit port2
set ip 172.20.120.12/24

end

To add a FortiClient license to each cluster unit

Normally you would add FortiClient licenses to the FortiGates before forming the cluster. However, you can use
the following steps to add FortiClient licenses to an operating cluster.

Contact your reseller to purchase FortiClient licenses for your cluster units. Each cluster unit must have its own
FortiClient license.

When you receive the license keys you can log into https://support.fortinet.com and add a FortiClient license key
to each licensed FortiGate. Then, as long as the cluster can connect to the Internet the license keys are
downloaded from the FortiGuard network to all of the FortiGates in the cluster.

You can also use the following steps to manually add the license keys to your cluster units from the CLI. Your
cluster must be connected to the Internet.

1. Log into the CLI of each cluster unit using its reserved management interface IP address.
2. Enter the following command to the unit’s serial number:

get system status

3. Enter the following command to add the license key for that serial number:
execute FortiClient-NAC update-registration-license <license-key>
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4. Confirm that the license has been installed and the correct number of FortiClients are licensed.
execute forticlient info
Maximum FortiClient connections: unlimited.
Licensed connections: 114

NAC: 114
WANOPT: 0
Test: 0
Other connections:

IPsec: 0
SSLVPN: 0

5. Repeat for all of the cluster units.
You can also log into the primary unit CLI and use the execute ha manage command to connect to each
cluster unit CLI.

Converting a standalone FortiGate to a cluster
In this example, a backup FortiGate will be installed and connected to a FortiGate that has previously been
installed to provide redundancy if the primary FortiGate fails.

In this recipe, a backup FortiGate unit is installed and connected to a previously installed FortiGate to form a high
availability (HA) cluster that improves network reliability.

Before you begin, the FortiGates should be running the same FortiOS firmware version and interfaces should not
be configured to get their addresses from DHCP or PPPoE. Also, you cannot use a switch port as an HA heartbeat
interface. If necessary, convert the switch port to individual interfaces.

This example uses the FortiGate Clustering Protocol (FGCP) for HA. The previously installed FortiGate will
continue to operate as the primary unit and the new FortiGate will operate as the backup FortiGate.
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1. Setting up registration and licensing

Make sure both FortiGates are
running the same FortiOS firmware
version. Register and apply licenses
to the new FortiGate unit before
adding it to the HA cluster. This
includes licensing for FortiCare
Support, IPS, AntiVirus, Web
Filtering, Mobile Malware,
FortiClient, FortiCloud, and
additional virtual domains
(VDOMs). All FortiGates in the
cluster must have the same level of
licensing for FortiGuard, FortiCloud,
FortiClient, and VDOMs.
FortiToken licenses can be added
at any time because they are
synchronized to all cluster members.

If the FortiGates in the cluster will
be running FortiOS Carrier, apply
the FortiOS Carrier license before
configuring the cluster (and before
applying other licenses). Applying
the FortiOS Carrier license sets the
configuration to factory defaults,
requiring you to repeat steps
performed before applying the
license.

You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed, third-party certificates are synchronized to the backup FortiGate.

2. Configuring the primary FortiGate for HA

On the primary FortiGate, go to
System > Settings and change the
Host name to identify this as the
primary FortiGate in the HA cluster.
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Go to System > HA and set theMode to Active-Passive. Set the Device priority to a higher value than
the default (in the example, 250) to make sure this FortiGate will always be the primary FortiGate. Also, set
aGroup name and Password.

Make sure that two Heartbeat interfaces (in the example, port3 and port4) are selected and the Heartbeat
Interface Priority for each is set to 50.

Since the backup FortiGate is not available, when you save the HA configuration, the primary FortiGate will
form a cluster of one FortiGate but will keep operating normally. If these steps don't start HAmode, make
sure that none of the FortiGate's interfaces use DHCP or PPPoE addressing.

If there are other FortiOS HA
clusters on your network, you may
need to change the cluster group ID
using this CLI command.

config system ha
set group-id 25

end

3. Connecting the backup FortiGate
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Connect the backup FortiGate to the
primary FortiGate and the network,
as shown in the network diagram at
the top of the recipe. Making these
network connections will disrupt
traffic so you should do this when
the network is not processing much
traffic.

If possible, make direct Ethernet connections between the heartbeat interfaces of the two FortiGate units.
This example uses two FortiGate-600Ds and the default heartbeat interfaces are used (port3 and port4).
You can use any interfaces for HA heartbeat interfaces. A best practice is to use interfaces that do not
process traffic, but this is not a requirement.

Switches must be used between the cluster and the Internet, and between the cluster and the internal
networks, as shown in the network diagram. You can use any good quality switches to make these
connections. You can also use one switch for all of these connections, as long as you configure the switch to
separate traffic from the different networks.

4. Configuring the backup FortiGate for HA

Connect to the backup FortiGate
GUI and go to System > Settings
and change the Host name to
identify this as the backup
FortiGate.

Go to System > HA and duplicate the HA configuration of the primary FortiGate (except for the Device
priority): set Mode to Active-Passive, and set the Device Priority to a lower value than the default to
make sure this FortiGate will always be the backup FortiGate. Also, set the sameGroup name and
Password as the primary FortiGate.

Make sure that the same two Heartbeat interfaces (port3 and port4) are selected and the Heartbeat
Interface Priority for each is set to 50.
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If you changed the cluster group id
of the primary FortiGate, change the
cluster group ID for the backup
FortiGate to match, using this CLI
command.

config system ha
set group-id 25

end

When you save the HA configuration of the backup FortiGate, if the heartbeat interfaces are connected, the
FortiGates will find each other and form an HA cluster. Network traffic may be disrupted for a few seconds
while the cluster is negotiating. If these steps don't start HAmode, make sure that none of the FortiGate's
interfaces use DHCP or PPPoE addressing.

5. Viewing the status of the HA cluster
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Connect to the GUI of the primary
FortiGate. The HA Statuswidget
shows the cluster mode (Mode) and
group name (Group). It also shows
the host name of the primary
FortiGate (Master), which you can
hover over to verify that the cluster is
synchronized and operating
normally. You can click on the
widget to change the HA
configuration or view a list of
recently recorded cluster events,
such as members joining or leaving
the cluster.

Click on the HA Status widget and select Configure settings in System > HA (or go to System > HA)
to view the cluster status.

If the cluster is part of a Security Fabric, the FortiView Physical and Logical Topology views show
information about the cluster status.
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6. Results

Traffic is now passing through the primary FortiGate. However, if the primary FortiGate becomes
unavailable, traffic should fail over and the backup FortiGate will process traffic.

A failover also causes the primary and backup FortiGate to reverse roles, even when both FortiGates are
available again.

To test HA failover, from a PC on
the internal network, ping an IP
address on the Internet (in the
example, 8.8.8.8). After a moment,
power off the primary FortiGate. If
you are using port monitoring, you
can also unplug the primary
FortiGate's Internet-facing interface
to test failover. You will see a
momentary pause in the ping
results, until traffic fails over to the
backup FortiGate, allowing the ping
traffic to continue.
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7. (Optional) Upgrading the firmware for the HA cluster

Upgrading the firmware on the primary FortiGate automatically upgrades the firmware on the backup
FortiGate. Both FortiGates are updated with minimal traffic disruption. For information about accessing
firmware images, see Verifying and updating the FortiGate unit's firmware.

Always review the Release Notes and Supported Upgrade Paths before installing new firmware.

Click the System Information
widget and select Update firmware
in System > Firmware. Back up
the configuration and update the
firmware from FortiGuard or by
uploading a firmware image file.
The firmware installs onto both the
primary and backup FortiGates.

After the upgrade is complete, verify
that the System Information
widget shows the new firmware
version.
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Replacing a failed cluster unit
This procedure describes how to remove a failed cluster unit from a cluster and add a new one to replace it. You
can also use this procedure to remove a failed unit from a cluster, repair it and add it back to the cluster.
Replacing a failed does not interrupt the operation of the cluster unless you have to change how the cluster is
connected to the network to accommodate the replacement unit.

You can use this procedure to replace more than one cluster unit.

To replace a failed cluster unit

1. Disconnect the failed unit from the cluster and the network.
If you maintain other connections between the network and the still functioning cluster unit or units
and between remaining cluster units network traffic will continue to be processed.

2. Repair the failed cluster unit, or obtain a replacement unit with the exact same hardware configuration as the
failed cluster unit.

3. Install the same firmware build on the repaired or replacement unit as is running on the cluster.
4. Register and apply licenses to the FortiGate. This includes FortiCloud activation and FortiClient licensing, and

entering a license key if you purchased more than 10 Virtual Domains (VDOMS). All of the FortiGates in a
cluster must have the same level of licensing.
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5. You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed third-party certificates are synchronized to the backup FortiGate.
We recommend that you add FortiToken licenses and FortiTokens to the primary unit after the cluster has formed.

6. Configure the repaired or replacement unit for HA operation with the same HA configuration as the cluster.
7. If the cluster is running in transparent mode, change the operating mode of the repaired or replacement unit to

transparent mode.
8. Connect the repaired or replacement cluster unit to the cluster.

For an example see How to set up FGCP clustering (recommended steps) on page 1771.

9. Power on the repaired or replacement cluster unit.
When the unit starts it negotiates to join the cluster. After it joins the cluster, the cluster synchronizes
the repaired or replacement unit configuration with the configuration of the primary unit.

You can add a repaired or replacement unit to a functioning cluster at any time. The repaired or replacement
cluster unit must:

l Have the same hardware configuration as the cluster units. Including the same hard disk configuration and the
same AMC cards installed in the same slots.

l Have the same firmware build as the cluster.
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l Be set to the same operating mode (NAT or transparent) as the cluster.
l Be operating in single VDOM mode.

FGCP HA with 802.3ad aggregated interfaces
On FortiGate models that support it you can use 802.3ad link aggregation to combine two or more interfaces into
a single aggregated interface. 802.3ad Link Aggregation and it's management protocol, Link Aggregation Control
Protocol (LACP) are a method for combining multiple physical links into a single logical link.This increases both
potential throughput and network resiliency. Using LACP, traffic is distributed among the physical interfaces in
the link, potentially resulting in increased performance.

This example describes how to configure an HA cluster consisting of two FortiGates with two aggregated 1000
Mb connections to the Internet using port1 and port2 and two aggregated 1000 Mb connections to the internal
network using port3 and port4. The aggregated interfaces are also configured as HAmonitored interfaces.

Each of the aggregate links connects to a different switch. Each switch is configured for link aggregation
(2x1000Mb).

Example cluster with aggregate interfaces

HA interface monitoring, link failover, and 802.3ad aggregation

When monitoring the aggregated interface, HA interface monitoring treats the aggregated link as a single
interface and does not monitor the individual physical interfaces in the link. HA interface monitoring registers the
link to have failed only if all the physical interfaces in the link have failed. If only some of the physical interfaces in
the link fail or become disconnected, HA considers the link to be operating normally.
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HA MAC addresses and 802.3ad aggregation

If a configuration uses the Link Aggregate Control Protocol (LACP) (either passive or active), LACP is negotiated
over all of the interfaces in any link. For a standalone FortiGate, the FortiGate LACP implementation uses the
MAC address of the first interface in the link to uniquely identify that link. For example, a link consisting of port1
and port2 interfaces would have the MAC address of port1.

In an HA cluster, HA changes the MAC addresses of the cluster interfaces to virtual MAC addresses. An
aggregate interface in a cluster acquires the virtual MAC address that would have been acquired by the first
interface in the aggregate.

Link aggregation, HA failover performance, and HA mode

To operate an active-active or active-passive cluster with aggregated interfaces and for best performance of a
cluster with aggregated interfaces, the switches used to connect the cluster unit aggregated interfaces together
should support configuring multiple Link Aggregation (LAG) groups.

For example, the cluster shown above should be configured into two LAG groups on the external switch: one for
the port1 and port2 aggregated interface of FGT_ha_1 and a second one for the port1 and port2 aggregate
interface of FGT_ha_2. You should also be able to do the same on the internal switch for the port3 and port4
aggregated interfaces of each cluster unit.

As a result, the subordinate unit aggregated interfaces would participate in LACP negotiation while the cluster is
operating. In an active-active mode cluster, packets could be redirected to the subordinate unit interfaces. As
well, in active-active or active-passive mode, after a failover the subordinate unit can become a primary unit
without having to perform LACP negotiation before it can process traffic. Performing LACP negotiation causes a
minor failover delay.

However if you cannot configure multiple LAG groups on the switches, due to the primary and subordinate unit
interfaces having the same MAC address, the switch will put all of the interfaces into the same LAG group which
would disrupt the functioning of the cluster. To prevent this from happening, you must change the FortiGate
aggregated interface configuration to prevent subordinate units from participating in LACP negotiation.

For example, use the following command to prevent subordinate units from participating in LACP negotiation
with an aggregate interface named Port1_Port2:

config system interface
edit Port1_Port2

set lacp-ha-slave disable
end

As a result of this setting, subordinate unit aggregated interfaces cannot accept packets. This means that you
cannot operate the cluster in active-active mode because in active-active mode the subordinate units must be
able to receive and process packets. Also, failover may take longer because after a failover the subordinate unit
has to perform LACP negotiation before being able to process network traffic.

Also, it may also be necessary to configure the switch to use Passive or even Static mode for LACP to prevent the
switch from sending packets to the subordinate unit interfaces, which won’t be able to process them.

Finally, in some cases depending on the LACP configuration of the switches, you may experience delayed
failover if the FortiGate LACP configuration is not compatible with the switch LACP configuration. For example, in
some cases setting the FortiGate LACPmode to static reduces the failover delay because the FortiGate does not
perform LACP negotiation. However there is a potential problem with this configuration because static LACP
does not send periodic LAC Protocol Data Unit (LACPDU) packets to test the connections. So a non-physical
failure (for example, if a device is not responding because its too busy) may not be detected and packets could be
lost or delayed.
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General configuration steps

The section includes GUI and CLI procedures. These procedures assume that the FortiGates are running the
same FortiOS firmware build and are set to the factory default configuration.

General configuration steps

1. Apply licenses to the FortiGates to become the cluster.
2. Configure the FortiGates for HA operation.

l Change each unit’s host name.
l Configure HA.

2. Connect the cluster to the network.
3. View cluster status.
4. Add basic configuration settings and configure the aggregated interfaces.

l Add a password for the admin administrative account.
l Add the aggregated interfaces.
l Disable lacp-ha-slave so that the subordinate unit does not send LACP packets.
l Add a default route.

You could also configure aggregated interfaces in each FortiGate before the units form a cluster.

5. Configure HA port monitoring for the aggregated interfaces.

Configuring active-passive HA cluster that includes aggregated interfaces - GUI

These procedures assume you are starting with two FortiGates with factory default settings.

To configure the FortiGates for HA operation

1. Register and apply licenses to the FortiGate.
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2. On the System Information dashboard widget, beside Host Name select Change.
3. Enter a new Host Name for this FortiGate.

New Name FGT_ha_1

4. Select OK.
5. Go to System > HA and change the following settings.

Mode Active-Passive

Group Name example5.com

Password HA_pass_5

Heartbeat Interface

Enable Priority

port5 Select 50

port6 Select 50

Since port3 and port4 will be used for an aggregated interface, you must change the HA heartbeat
configuration to not use those interfaces.

6. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address
of the FortiGate interfaces. The MAC addresses of the FortiGate interfaces change to the following
virtual MAC addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-0b
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0e
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
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l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
MAC: 00:09:0f:09:00:00
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

7. Power off the first FortiGate.
8. Repeat these steps for the second FortiGate.

Set the second FortiGate host name to:

New Name FGT_ha_2

To connect the cluster to the network

1. Connect the port1 and port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
Configure the switch so that the port1 and port2 of FGT_ha_1 make up an aggregated interface and
port1 and port2 of FGT_ha_2 make up a second aggregated interface.

2. Connect the port3 and port4 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal
network.
Configure the switch so that the port3 and port4 of FGT_ha_1 make up an aggregated interface and
port3 and port4 of FGT_ha_2 make up another aggregated interface.

3. Connect the port5 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or
regular Ethernet cables and a switch.

4. Connect the port5 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular
Ethernet cables and a switch.

5. Power on the cluster units.
The units negotiate to choose the primary unit and the subordinate unit. This negotiation occurs with
no user intervention and normally takes less than a minute.

When negotiation is complete, the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view the cluster dashboard and cluster members list to confirm that the cluster units
are operating as a cluster.
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1. View the system dashboard.
The HA Status dashboard widget displays how long the cluster has been operating (Uptime) and the
time since the last failover occurred (State Changed) You can hover over the State Changed time to
see the event that caused the state change. You can also click on the HA Status dashboard widget to
configure HA settings or to get a listing of the most recent HA events recorded by the cluster.

2. Go to System > HA to view the cluster members list.
The list shows both cluster units, their host names, their roles in the cluster, and their device priorities.
You can use this list to confirm that the cluster is operating normally. For example, if the list shows
only one cluster unit then the other unit has left the cluster for some reason.

To troubleshoot the cluster configuration

See Troubleshooting HA clusters on page 1845 to troubleshoot the cluster.

To add basic configuration settings and the aggregate interfaces

Use the following steps to add a few basic configuration settings.

1. Log into the cluster GUI.
2. Go to System > Administrators.
3. Edit admin and select Change Password.
4. Enter and confirm a new password.
5. Select OK.
6. Go to Network > Static Routes and temporarily delete the default route.

You cannot add an interface to a aggregated interface if any settings (such as the default route) are
configured for it.

7. Go to Network > Interfaces and select Create New > Interface to add the aggregate interface to connect to the
Internet.

8. Set Type to 802.3ad Aggregate and configure the aggregate interface to be connected to the Internet:

Name Port1_Port2

Interface Members port1, port2

IP/Network Mask 172.20.120.141/24

9. Select OK.
10. Select Create New > Interface to add the aggregate interface to connect to the internal network.
11. Set Type to 802.3ad Aggregate and configure the aggregate interface to be connected to the Internet:

Name Port3_Port4

Interface Members port3, port4

IP/Netmask 10.11.101.100/24

Administrative Access HTTPS, PING, SSH

12. Select OK.
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The virtual MAC addresses of the FortiGate interfaces change to the following. Note that port1 and
port2 both have the port1 virtual MAC address and port3 and port4 both have the port3 virtual MAC
address:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-00 (same as port1)
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0d (same as port3)
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

13. Connect to the CLI and enter the following command to disable sending LACP packets from the subordinate unit:
config system interface

edit Port1_Port2
set lacp-ha-slave disable

next
edit Port3_Port4

set lacp-ha-slave disable
end

14. Go to Network > Static Routes.
15. Add the default route.

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.2

Device Port1_Port2

Distance 10

16. Select OK.
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To configure HA port monitoring for the aggregate interfaces

1. Go to System > HA.
2. In the cluster members list, edit the primary unit.
3. Configure the following port monitoring for the aggregate interfaces:

Port Monitor

Port1_Port2 Select

Port3_Port4 Select

4. Select OK.

Configuring active-passive HA cluster that includes aggregate interfaces - CLI

These procedures assume you are starting with two FortiGates with factory default settings.

To configure the FortiGates for HA operation

1. Register and apply licenses to the FortiGate. This includes FortiCloud activation and FortiClient licensing, and
entering a license key if you purchased more than 10 Virtual Domains (VDOMS). All of the FortiGates in a
cluster must have the same level of licensing.

2. Install any third-party certificates on the FortiGate.
3. Change the host name for this FortiGate:

config system global
set hostname FGT_ha_1

end

4. Configure HA settings.
config system ha

set mode a-p
set group-name example5.com
set password HA_pass_5
set hbdev port5 50 port6 50

end

Since port3 and port4 will be used for an aggregated interface, you must change the HA heartbeat
configuration.

The FortiGate negotiates to establish an HA cluster. You may temporarily lose connectivity with the
FortiGate as the HA cluster negotiates and the FGCP changes the MAC address of the FortiGate
interfaces. The MAC addresses of the FortiGate interfaces change to the following virtual MAC
addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
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l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-0b
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0e
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
MAC: 00:09:0f:09:00:00
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

4. Repeat these steps for the other FortiGate.
Set the other FortiGate host name to:

config system global
set hostname FGT_ha_2

end

To connect the cluster to the network

1. Connect the port1 and port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
Configure the switch so that the port1 and port2 of FGT_ha_1 make up an aggregated interface and
port1 and port2 of FGT_ha_2 make up another aggregated interface.

2. Connect the port3 and port4 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal
network.
Configure the switch so that the port3 and port4 of FGT_ha_1 make up an interfaced and port3 and
port4 of FGT_ha_2 make up another aggregated interface.
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3. Connect the port5 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or
regular Ethernet cables and a switch.

4. Connect the port5 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular
Ethernet cables and a switch.

5. Power on the cluster units.
The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention and normally takes less than a minute.

When negotiation is complete the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view cluster status from the CLI.

1. Log into the CLI.
2. Enter get system status to verify the HA status of the cluster unit that you logged into. Look for the following

information in the command output.

Current HA mode: a-a, master The cluster units are operating as a cluster and you have
connected to the primary unit.

Current HA mode: a-a, backup The cluster units are operating as a cluster and you have
connected to a subordinate unit.

Current HA mode: standalone The cluster unit is not operating in HAmode

3. Enter the following command to view the status of the cluster:

get system ha status
HA Health Status: OK
Model: FortiGate-XXXX
Mode: HA A-P
Group: 0
Debug: 0
Cluster Uptime: 7 days 00:30:26
.
.
.

You can use this command to confirm that the cluster is healthy and operating normally, some
information about the cluster configuration, and information about how long the cluster has been
operating. Information not shown in this example includes how the primary unit was selected,
configuration synchronization status, usage stats for each cluster unit, heartbeat status, and the
relative priorities of the cluster units.

To troubleshoot the cluster configuration

See Troubleshooting HA clusters on page 1845 to troubleshoot the cluster.

To add basic configuration settings and the aggregate interfaces

Use the following steps to add a few basic configuration settings and the aggregate interfaces.

1. Add a password for the admin administrative account.
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config system admin
edit admin

set password <psswrd>
end

2. Temporarily delete the default route.
You cannot add an interface to an aggregate interface if any settings (such as the default route) are
configured for it. In this example the index of the default route is 1.

config router static
delete 1

end

3. Add the aggregate interfaces:
config system interface

edit Port1_Port2
set type aggregate
set lacp-ha-slave disable
set member port1 port2
set ip 172.20.120.141/24
set vdom root

next
edit Port3_Port4

set type aggregate
set lacp-ha-slave disable
set member port3 port4
set ip 10.11.101.100/24
set vdom root

end

The virtual MAC addresses of the FortiGate interfaces change to the following. Note that port1 and
port2 both have the port1 virtual MAC address and port3 and port4 both have the port3 virtual MAC
address:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-00 (same as port1)
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0d (same as port3)
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
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l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

4. Add the default route.
config router static

edit 1
set dst 0.0.0.0 0.0.0.0
set gateway 172.20.120.2
set device Port1_Port2

end

To configure HA port monitoring for the aggregate interfaces

1. Configure HA port monitoring for the aggregate interfaces.
config system ha

set monitor Port1_Port2 Port3_Port4
end

Example HA and redundant interfaces
On FortiGate models that support it you can combine two or more interfaces into a single redundant interface. A
redundant interface consists of two or more physical interfaces. Traffic is processed by the first physical interface
in the redundant interface. If that physical interface fails, traffic fails over to the next physical interface.
Redundant interfaces don’t have the benefit of improved performance that aggregate interfaces can have, but
they do provide failover if a physical interface fails or is disconnected.

Example cluster with a redundant interfaces

This example describes how to configure an HA cluster consisting of two FortiGates with a redundant interface
connection to the Internet and to an internal network. The connection to the Internet uses port1 and port2. The
connection to the internal network uses port3 and port4. The HA heartbeat uses port5 and port6.
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The redundant interfaces are also configured as HAmonitored interfaces.

HA interface monitoring, link failover, and redundant interfaces

HA interface monitoring monitors the redundant interface as a single interface and does not monitor the
individual physical interfaces in the redundant interface. HA interface monitoring registers the redundant interface
to have failed only if all the physical interfaces in the redundant interface have failed. If only some of the physical
interfaces in the redundant interface fail or become disconnected, HA considers the redundant interface to be
operating normally.

HA MAC addresses and redundant interfaces

For a standalone FortiGate a redundant interface has the MAC address of the first physical interface added to the
redundant interface configuration. A redundant interface consisting of port1 and port2 would have the MAC
address of port1.

In an HA cluster, HA changes the MAC addresses of the cluster interfaces to virtual MAC addresses. A redundant
interface in a cluster acquires the virtual MAC address that would have been acquired by the first physical
interface added to the redundant interface configuration.

Connecting multiple redundant interfaces to one switch while operating in active-passive HA
mode

HA assigns the same virtual MAC addresses to the subordinate unit interfaces as are assigned to the
corresponding primary unit interfaces. Consider a cluster of two FortiGates operating in active-passive mode with
a redundant interface consisting of port1 and port2. You can connect multiple redundant interfaces to the same
switch if you configure the switch so that it defines multiple separate redundant interfaces and puts the redundant
interfaces of each cluster unit into separate redundant interfaces. In this configuration, each cluster unit forms a
separate redundant interface with the switch.

However, if the switch is configured with a single four-port redundant interface configuration, because the same
MAC addresses are being used by both cluster units, the switch adds all four interfaces (port1 and port2 from the
primary unit and port1 and port2 from the subordinate unit) to the same redundant interface.

To avoid unpredictable results, when you connect a switch to multiple redundant interfaces in an active-passive
cluster you should configure separate redundant interfaces on the switch; one for each cluster unit.

Connecting multiple redundant interfaces to one switch while operating in active-active HA
mode

In an active-active cluster, all cluster units send and receive packets. To operate a cluster with redundant
interfaces in active-active mode, with multiple redundant interfaces connected to the same switch, you must
separate the redundant interfaces of each cluster unit into different redundant interfaces on the connecting
switch.

General configuration steps

The section includes GUI and CLI procedures. These procedures assume that the FortiGates are running the
same FortiOS firmware build and are set to the factory default configuration.

General configuration steps

1. Apply licenses to the FortiGates to become the cluster.
2. Configure the FortiGates for HA operation.
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l Change each unit’s host name.
l Configure HA.

2. Connect the cluster to the network.
3. View cluster status.
4. Add basic configuration settings and configure the redundant interfaces.

l Add a password for the admin administrative account.
l Add the redundant interfaces.
l Add a default route.

You could also configure redundant interfaces in each FortiGate before they form a cluster.

5. Configure HA port monitoring for the redundant interfaces.

Configuring active-passive HA cluster that includes redundant interfaces - GUI

These procedures assume you are starting with two FortiGates with factory default settings.

To configure the FortiGates for HA operation

1. Register and apply licenses to the FortiGate.

2. On the System Information dashboard widget, beside Host Name select Change.
3. Enter a new Host Name for this FortiGate.

New Name FGT_ha_1

4. Select OK.
5. Go to System > HA and change the following settings.

Mode Active-Passive
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Group Name example6.com

Password HA_pass_6

Heartbeat Interface

Enable Priority

port5 Select 50

port6 Select 50

Since port3 and port4 will be used for a redundant interface, you must change the HA heartbeat
configuration.

6. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address
of the FortiGate interfaces. The MAC addresses of the FortiGate interfaces change to the following
virtual MAC addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-0b
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0e
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
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command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
MAC: 00:09:0f:09:00:00
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

7. Power off the first FortiGate.
8. Repeat these steps for the second FortiGate.

Set the second FortiGate host name to:

New Name FGT_ha_2

To connect the cluster to the network

1. Connect the port1 and port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
Configure the switch so that the port1 and port2 of FGT_ha_1 make up a redundant interface and
port1 and port2 of FGT_ha_2 make up another redundant interface.

2. Connect the port3 and port4 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal
network.
Configure the switch so that the port3 and port4 of FGT_ha_1 make up a redundant interface and
port3 and port4 of FGT_ha_2 make up another redundant interface.

3. Connect the port5 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or
regular Ethernet cables and a switch.

4. Connect the port5 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular
Ethernet cables and a switch.

5. Power on the cluster units.
The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention and normally takes less than a minute.

When negotiation is complete the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view the cluster dashboard and cluster members list to confirm that the cluster units
are operating as a cluster.

1. View the system dashboard.
The HA Status dashboard widget displays how long the cluster has been operating (Uptime) and the
time since the last failover occurred (State Changed). You can hover over the State Changed time to
see the event that caused the state change. You can also click on the HA Status dashboard widget to
configure HA settings or to get a listing of the most recent HA events recorded by the cluster.

2. Go to System > HA to view the cluster members list.
The list shows both cluster units, their host names, their roles in the cluster, and their device priorities.
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You can use this list to confirm that the cluster is operating normally. For example, if the list shows
only one cluster unit then the other unit has left the cluster for some reason.

To troubleshoot the cluster configuration

See Troubleshooting HA clusters on page 1845.

To add basic configuration settings and the redundant interfaces

Use the following steps to add a few basic configuration settings.

1. Log into the cluster GUI.
2. Go to System > Administrators.
3. Edit admin and select Change Password.
4. Enter and confirm a new password.
5. Select OK.
6. Go to Network > Static Routes and temporarily delete the default route.

You cannot add an interface to a redundant interface if any settings (such as the default route) are
configured for it.

7. Go to Network > Interfaces and select Create New > Interface to add the redundant interface to connect to the
Internet.

8. Set Type to Redundant Interface and configure the redundant interface to be connected to the Internet:

Name Port1_Port2

Physical Interface Members port1, port2

IP/Netmask 172.20.120.141/24

9. Select OK.
10. Select Create New to add the redundant interface to connect to the internal network.
11. Set Type to Redundant Interface and configure the redundant interface to be connected to the Internet:

Name Port3_Port4

Physical Interface Members port3, port4

IP/Netmask 10.11.101.100/24

Administrative Access HTTPS, PING, SSH

12. Select OK.
The virtual MAC addresses of the FortiGate interfaces change to the following. Note that port1 and
port2 both have the port1 virtual MAC address and port3 and port4 both have the port3 virtual MAC
address:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
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l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-00 (same as port1)
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0d (same as port3)
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

13. Go to Router > Static > Static Routes.
14. Add the default route.

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.2

Device Port1_Port2

Distance 10

15. Select OK.

To configure HA port monitoring for the redundant interfaces

1. Go to System > HA.
2. In the cluster members list, edit the primary unit.
3. Configure the following port monitoring for the redundant interfaces:

Port Monitor

Port1_Port2 Select

Port3_Port4 Select

4. Select OK.

Configuring active-passive HA cluster that includes redundant interfaces - CLI

These procedures assume you are starting with two FortiGates with factory default settings.
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To configure the FortiGates for HA operation

1. Register and apply licenses to the FortiGate. This includes FortiCloud activation and FortiClient licensing, and
entering a license key if you purchased more than 10 Virtual Domains (VDOMS). All of the FortiGates in a
cluster must have the same level of licensing.

2. You can also install any third-party certificates on the primary FortiGate before forming the cluster. Once the
cluster is formed third-party certificates are synchronized to the backup FortiGate.
We recommend that you add FortiToken licenses and FortiTokens to the primary unit after the cluster has formed.

3. Change the host name for this FortiGate:
config system global

set hostname FGT_ha_1
end

4. Configure HA settings.
config system ha

set mode a-p
set group-name example6.com
set password HA_pass_6
set hbdev port5 50 port6 50

end

Since port3 and port4 will be used for a redundant interface, you must change the HA heartbeat
configuration.

The FortiGate negotiates to establish an HA cluster. You may temporarily lose connectivity with the
FortiGate as the HA cluster negotiates and the FGCP changes the MAC address of the FortiGate
interfaces. The MAC addresses of the FortiGate interfaces change to the following virtual MAC
addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-0b
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0e
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13
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To reconnect sooner, you can update the ARP table of your management PC by deleting the ARP
table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete the arp
table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
MAC: 00:09:0f:09:00:00
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

4. Repeat these steps for the other FortiGate.
Set the other FortiGate host name to:

config system global
set hostname FGT_ha_2

end

To connect the cluster to the network

1. Connect the port1 and port2 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the Internet.
Configure the switch so that the port1 and port2 of FGT_ha_1 make up a redundant interface and
port1 and port2 of FGT_ha_2 make up another redundant interface.

2. Connect the port3 and port4 interfaces of FGT_ha_1 and FGT_ha_2 to a switch connected to the internal
network.
Configure the switch so that the port3 and port4 of FGT_ha_1 make up a redundant interface and
port3 and port4 of FGT_ha_2 make up another redundant interface.

3. Connect the port5 interfaces of FGT_ha_1 and FGT_ha_2 together. You can use a crossover Ethernet cable or
regular Ethernet cables and a switch.

4. Connect the port5 interfaces of the cluster units together. You can use a crossover Ethernet cable or regular
Ethernet cables and a switch.

5. Power on the cluster units.
The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention and normally takes less than a minute.

When negotiation is complete the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view cluster status from the CLI.

1. Log into the CLI.
2. Enter get system status to verify the HA status of the cluster unit that you logged into.Look for the following

information in the command output.
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Current HA mode: a-a,
master

The cluster units are operating as a cluster and you have connected to the
primary unit.

Current HA mode: a-a,
backup

The cluster units are operating as a cluster and you have connected to a
subordinate unit.

Current HA mode:
standalone

The cluster unit is not operating in HAmode

3. Enter the following command to confirm the HA configuration of the cluster:

get system ha status
HA Health Status: OK
Model: FortiGate-XXXX
Mode: HA A-P
Group: 0
Debug: 0
Cluster Uptime: 7 days 00:30:26
.
.
.

You can use this command to confirm that the cluster is healthy and operating normally, some
information about the cluster configuration, and information about how long the cluster has been
operating. Information not shown in this example includes how the primary unit was selected,
configuration synchronization status, usage stats for each cluster unit, heartbeat status, and the
relative priorities of the cluster units.

To troubleshoot the cluster configuration

See Troubleshooting HA clusters on page 1845.

To add basic configuration settings and the redundant interfaces

Use the following steps to add a few basic configuration settings and the redundant interfaces.

1. Add a password for the admin administrative account.
config system admin

edit admin
set password <psswrd>

end

2. Temporarily delete the default route.
You cannot add an interface to a redundant interface if any settings (such as the default route) are
configured for it. In this example the index of the default route is 1.

config router static
delete 1

end

3. Add the redundant interfaces:
config system interface

edit Port1_Port2
set type redundant
set member port1 port2
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set ip 172.20.120.141/24
set vdom root

next
edit Port3_Port4

set type redundant
set member port3 port4
set ip 10.11.101.100/24
set vdom root

end

The virtual MAC addresses of the FortiGate interfaces change to the following. Note that port1 and
port2 both have the port1 virtual MAC address and port3 and port4 both have the port3 virtual MAC
address:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-00 (same as port1)
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0d (same as port3)
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

4. Add the default route.
config router static

edit 1
set dst 0.0.0.0 0.0.0.0
set gateway 172.20.120.2
set device Port1_Port2

end

To configure HA port monitoring for the redundant interfaces

1. Configure HA port monitoring for the redundant interfaces.
config system ha

set monitor Port1_Port2 Port3_Port4
end
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Troubleshooting HA clusters
This section describes some HA clustering troubleshooting techniques.

Ignoring hardware revisions

Many FortiGate platforms have gone through multiple hardware versions and in some cases the hardware
changes prevent cluster formation. If you run into this problem you can use the following command on each
FortiGate to cause the cluster to ignore different hardware versions:

execute ha ignore-hardware-revision enable

This command is only available on FortiGates that have had multiple hardware revisions.

By default the command is set to prevent cluster formation between FortiGates with different hardware revisions.
You can enter the following command to view its status:

execute ha ignore-hardware-revision status

Usually the incompatibility is caused by different hardware versions having different hard disks and enabling this
command disables each FortiGate's hard disks. As a result of disabling hard disks the cluster will not support
logging to the hard disk or WAN Optimization.

If the FortiGates do have compatible hardware versions or if you want to run a FortiGate in standalone mode you
can enter the following command to disable ignoring the hardware revision and enable the hard disks:

execute ha ignore-hardware-revision disable

Affected models include but are not limited to:

l FortiGate-100D
l FortiGate-300C
l FortiGate-600C
l FortiGate-800C
l FortiGate-80C and FortiWiFi-80C
l FortiGate-60C

Its possible that a cluster will not form because the disk partition sizes of the cluster
units are different. You can use the diagnose sys ha checksum test |
grep storage command to check the disk storage checksum of each cluster unit. If
the checksums are different then visit the Fortinet Support website for help in setting
up compatible storage partitions.

Before you set up a cluster

Before you set up a cluster ask yourself the following questions about the FortiGates that you are planning to use
to create a cluster.

1. Do all the FortiGates have the same hardware configuration? Including the same hard disk configuration?
2. Do all of the FortiGates have the same FortiGuard, FortiCloud, FortiClient, VDOM and FortiOS Carrier licensing?
3. Do all the FortiGates have the same firmware build?
4. Are all the FortiGates set to the same operating mode (NAT or transparent)?
5. Are all the FortiGates operating in single VDOM mode?
6. If the FortiGates are operating in multiple VDOM mode do they all have the same VDOM configuration?
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In some cases you may be able to form a cluster if different FortiGates have different
firmware builds, different VDOM configurations, and are in different operating modes.
However, if you encounter problems they may be resolved by installing the same
firmware build on each unit, and give them the same VDOM configuration and
operating mode. If the FortiGates in the cluster have different licenses, the cluster will
form but it will operate with the lowest licensing level.

Troubleshooting the initial cluster configuration

This section describes how to check a cluster when it first starts up to make sure that it is configured and
operating correctly. This section assumes you have already configured your HA cluster.

To verify that a cluster can process traffic and react to a failure

1. Add a basic security policy configuration and send network traffic through the cluster to confirm connectivity.
For example, if the cluster is installed between the Internet and an internal network, set up a basic
internal to external security policy that accepts all traffic. Then from a PC on the internal network,
browse to a website on the Internet or ping a server on the Internet to confirm connectivity.

2. From your management PC, set ping to continuously ping the cluster, and then start a large download, or in some
other way establish ongoing traffic through the cluster.

3. While traffic is going through the cluster, disconnect the power from one of the cluster units.
You could also shut down or restart a cluster unit.

Traffic should continue with minimal interruption.

4. Start up the cluster unit that you disconnected.
The unit should re-join the cluster with little or no affect on traffic.

5. Disconnect a cable from one of the HA heartbeat interfaces.
The cluster should keep functioning, using the other HA heartbeat interface.

6. If you have port monitoring enabled, disconnect a network cable from a monitored interface.
Traffic should continue with minimal interruption.

To verify the cluster configuration from the GUI

Use these steps if a cluster is formed just to verify its status and configuration.

1. Log into the cluster GUI.
2. Check the system dashboard to verify that the System Information widget displays all of the cluster units.
3. Check the Unit Operation widget graphic to verify that the correct cluster unit interfaces are connected.
4. Go to System > HA or from the System Information dashboard widget select HA Status > Configure and verify

that all of the cluster units are displayed on the HACluster list.
5. From the cluster members list, edit the primary unit (master) and verify the cluster configuration is as expected.

To troubleshoot the cluster configuration from the GUI

Use these steps if the FortiGates don't successfully form a cluster:

1. Connect to each cluster unit GUI and verify that the HA configurations are the same. The HA configurations of all
of the cluster units must be identical. Even though the HA configuration is very simple you can easily make a small
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mistake that prevents a FortiGate from joining a cluster.
2. If the configurations are the same, try re-entering the HAPassword on each cluster unit in case you made an

error typing the password when configuring one of the cluster units.
3. Check that the correct interfaces of each cluster unit are connected.

Check the cables and interface LEDs.

Use the Unit Operation dashboard widget, system network interface list, or cluster members list to
verify that each interface that should be connected actually is connected.

If the link is down re-verify the physical connection. Try replacing network cables or switches as
required.

To verify the cluster configuration from the CLI

Use these steps if a cluster is formed just to verify its status and configuration.

1. Log into each cluster unit CLI.
You can use the console connection if you need to avoid the problem of units having the same IP
address.

2. Enter the command get system status.
Look for the following information in the command output.

Current HA mode: a-a,
master

The cluster units are operating as a cluster and you have connected to the
primary unit.

Current HA mode: a-a,
backup

The cluster units are operating as a cluster and you have connected to a
subordinate unit.

Current HA mode:
standalone

The cluster unit is not operating in HAmode

3. Verify that the get system ha status command shows that the cluster health is OK and shows that all of
the cluster units have joined the cluster.

4. Enter the get system ha command to verify that the HA configuration is correct and the same for each cluster
unit.

To troubleshoot the cluster configuration from the CLI

Try these steps if the FortiGates don't successfully form a cluster:

1. Try using the following command to re-enter the cluster password on each cluster unit in case you made an error
typing the password when configuring one of the cluster units.

config system ha
set password <password>

end

2. Check that the correct interfaces of each cluster unit are connected.
Check the cables and interface LEDs.

Use get hardware nic <interface_name> command to confirm that each interface is
connected. If the interface is connected the command output should contain a Link: up entry
similar to the following:
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get hardware nic port1
.
.
.
Link: up
.
.
.

If the link is down, re-verify the physical connection. Try replacing network cables or switches as
required.

More troubleshooting information

Much of the information in this HA guide can be useful for troubleshooting HA clusters. Here are some links to
sections with more information.

l If sessions are lost after a failover you may need to change route-ttl to keep synchronized routes active longer. See
Synchronizing kernel routing tables on page 1933

l To control which cluster unit becomes the primary unit, you can change the device priority and enable override. See
Controlling primary unit selection using device priority and override on page 1754Controlling primary unit selection
using device priority and override on page 1754

l Changes made to a cluster can be lost if override is enabled. See Configuration changes can be lost if override is
enabled on page 1755

l When override is enabled, after a failover traffic may be disrupted if the primary unit rejoins the cluster before the
session tables are synchronized or for other reasons such as if the primary unit is configured for DHCP or PPPoE.
See Delaying how quickly the primary unit rejoins the cluster when override is enabled on page 1756.

l In some cases, age differences among cluster units result in the wrong cluster unit becoming the primary unit. For
example, if a cluster unit set to a high priority reboots, that unit will have a lower age than other cluster units. You
can resolve this problem by resetting the age of one or more cluster units. See Primary unit selection and age on
page 1747 You can also adjust how sensitive the cluster is to age differences. This can be useful if large age
differences cause problems. See Cluster age difference margin (grace period) on page 1747 and Changing the
cluster age difference margin on page 1748.

l If one of the cluster units needs to be serviced or removed from the cluster for other reasons, you can do so without
affecting the operation of the cluster. See Disconnecting a cluster unit from a cluster on page 1905

l The GUI and CLI will not allow you to configure HA if you have enabled FGSPHA. See FortiGate Session Life
Support Protocol (FGSP) on page 1991.

l The GUI and CLI will not allow you to configure HA if one or more FortiGate interfaces is configured as a PPTP or
L2TP client.

l The FGCP is compatible with DHCP and PPPoE but care should be taken when configuring a cluster that includes a
FortiGate interface configured to get its IP address with DHCP or PPPoE. Fortinet recommends that you turn on
DHCP or PPPoE addressing for an interface after the cluster has been configured. See FortiGate HA compatibility
with DHCP and PPPoE on page 1756.

l Some third-party network equipment may prevent HA heartbeat communication, resulting in a failure of the cluster
or the creation of a split brain scenario. For example, some switches use packets with the same Ethertype as HA
heartbeat packets use for internal functions and when used for HA heartbeat communication the switch generates
CRC errors and the packets are not forwarded. See Heartbeat packet Ethertypes on page 1915.

l Very busy clusters may not be able to send HA heartbeat packets quickly enough, also resulting in a split brain
scenario. You may be able to resolve this problem by modifying HA heartbeat timing. See Modifying heartbeat
timing on page 1916.
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l Very busy clusters may suffer performance reductions if session pickup is enabled. If possible you can disable this
feature to improve performance. If you require session pickup for your cluster, several options are available for
improving session pickup performance. See Improving session synchronization performance on page 1954.

l If it takes longer than expected for a cluster to failover you can try changing how the primary unit sends gratuitous
ARP packets. See Changing how the primary unit sends gratuitous ARP packets after a failover on page 1919.

l You can also improve failover times by configuring the cluster for sub-second failover. See Sub-second failover on
page 1942 and Failover performance on page 1951.

l When you first put a FortiGate in HAmode you may loose connectivity to the unit. This occurs because HA changes
the MAC addresses of all FortiGate interfaces, including the one that you are connecting to. The cluster MAC
addresses also change if you change some HA settings such as the cluster group ID. The connection will be
restored in a short time as your network and PC updates to the new MAC address. To reconnect sooner, you can
update the ARP table of your management PC by deleting the ARP table entry for the FortiGate (or just deleting all
arp table entries). You may be able to delete the arp table of your management PC from a command prompt using
a command similar to arp -d.

l Since HA changes all cluster unit MAC addresses, if your network uses MAC address filtering you may have to make
configuration changes to account for the HAMAC addresses.

l A network may experience packet loss when two FortiGate HA clusters have been deployed in the same broadcast
domain. Deploying two HA clusters in the same broadcast domain can result in packet loss because of MAC
address conflicts. The packet loss can be diagnosed by pinging from one cluster to the other or by pinging both of
the clusters from a device within the broadcast domain. You can resolve the MAC address conflict by changing the
HAGroup ID configuration of the two clusters. The HAGroup ID is sometimes also called the Cluster ID. See
Diagnosing packet loss with two FortiGate HA clusters in the same broadcast domain on page 1923

l The cluster CLI displays slave is not in sync messages if there is a synchronization problem between the
primary unit and one or more subordinate units. See How to diagnose HA out of sync messages on page 1931.

l If you have configured dynamic routing and the new primary unit takes too long to update its routing table after a
failover you can configure graceful restart and also optimize how routing updates are synchronized. See Configuring
graceful restart for dynamic routing failover on page 1935 and Synchronizing kernel routing tables on page 1933.

l Some switches may not be able to detect that the primary unit has become a subordinate unit and will keep sending
packets to the former primary unit. This can occur after a link failover if the switch does not detect the failure and
does not clear its MAC forwarding table. See Updating MAC forwarding tables when a link failover occurs on page
1940.

l If a link not directly connected to a cluster unit (for example, between a switch connected to a cluster interface and
the network) fails you can enable remote link failover to maintain communication. See Remote link failover (remote
IPmonitoring) on page 1943.

l If you find that some cluster units are not running the same firmware build you can reinstall the correct firmware
build on the cluster to upgrade all cluster units to the same firmware build. See Synchronizing the firmware build
running on a new cluster unit on page 1895.
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Virtual clusters

This chapter describes virtual clustering, a variation of the FGCP for FortiGates with multiple VDOMs. Virtual
clustering includes can operate in active-passive or active-active HAmode for clusters of up to four FortiGates.
Active-passive virtual clustering includes VDOM partitioning that to distribute traffic for different VDOMs between
the primary and backup FortiGates.

Virtual clustering overview
Virtual clustering is an extension of the FGCP that provides failover protection between two instances of one or
more VDOMs operating on two FortiGates in a virtual cluster.

A standard virtual cluster consists of up to four FortiGates operating in active-passive or active-active HAmode
with multiple VDOMS enabled.

Active-passive virtual clustering uses VDOM partitioning to send traffic for some VDOMs to the primary FortiGate
and traffic for other VDOMs to the backup FortiGate. Traffic distribution between both FortiGates can potentially
improve throughput. If a failure occurs and only one FortiGate continues to operate, all traffic fails over to that
FortiGate, similar to normal HA. If the failed FortiGates restart, the configured traffic distribution is restored.

Active-active virtual clustering operates just the same as standard FGCP active-active HA, distributing traffic to all
of the FortiGates in the cluster using FGCP load balancing.

In an active-passive virtual cluster of two FortiGates, the primary and backup FortiGates share traffic processing
according to the VDOM partitioning configuration. If you add a third or fourth FortiGate, the primary and first
backup FortiGate process all traffic and the other one or two FortiGates operate in standby mode. If the primary
or first backup FortiGate fails, one of the other FortiGates becomes the new primary or backup FortiGate and
begins processing traffic.

The figure below shows an example virtual cluster configuration consisting of two FortiGates. The virtual cluster
has two VDOMs, root and Eng_vdm.
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Example virtual cluster

The root VDOM includes the port1 and port2 interfaces. The Eng_vdm VDOM includes the port5 and port6
interfaces. The port3 and port4 interfaces (not shown in the diagram) are the HA heartbeat interfaces.

If you don't want active-passive virtual clustering to distribute traffic between
FortiGates, you can configure VDOM partitioning to send traffic for all VDOMs to the
primary unit. The result is the same as standard active-passive FCGPHA, all traffic is
processed by the primary FortiGate.

Separation of VDOM traffic

Virtual clustering creates a cluster between instances of each VDOM on the two FortiGates in the virtual cluster.
All traffic to and from a given VDOM is sent to one of the FortiGates where it stays within its VDOM and is only
processed by that VDOM. One FortiGate is the primary FortiGate for each VDOM and one FortiGate is the
backup FortiGate for each VDOM. The primary FortiGate processes all traffic for its VDOMs. The backup
FortiGate processes all traffic for its VDOMs.

If your cluster has a VLAN that is part of a different VDOM than the physical interface
that the VLAN has been added to, then you must configure VDOM partitioning to keep
traffic for both of these VDOMs on the same FortiGate.
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Virtual clustering and heartbeat interfaces

The HA heartbeat provides the same HA services in a virtual clustering configuration as in a standard HA
configuration. One set of HA heartbeat interfaces provides HA heartbeat services for all of the VDOMs in the
cluster. You do not have to add a heartbeat interface for each VDOM.

Virtual clustering and load balancing

There are two ways to configure load balancing for virtual clustering. The first is to set the HAmode to active-
active. The second is to configure VDOM partitioning. For virtual clustering, setting the HAMode to active-active
has the same result as active-active HA for a cluster without virtual domains. The primary FortiGate receives all
sessions and load balances them among the cluster units according to the load balancing schedule. All cluster
units process traffic for all virtual domains.

In an active-passive virtual clustering configuration, you can configure a form of load balancing by using VDOM
partitioning to distribute traffic between the primary and backup FortiGates. While a cluster is operating, you can
change the VDOM partitioning configuration to change the distribution of traffic between the cluster units. For
example, if you have two VDOMs with high traffic volume you can set up VDOM partitioning so that different
FortiGates process the traffic for each high-volume VDOM. If over time traffic patterns change you can
dynamically re-adjust VDOM partitioning to optimize traffic throughput. VDOM partitioning can be changed at any
with only minor traffic disruptions.

Configuring virtual clustering
Configuring virtual clustering is the same as configuring standard FCGPHAwith the addition of VDOM
partitioning. Using VDOM partitioning you can control the distribution of VDOMs, and the traffic they process,
between the FortiGates in the cluster.

VDOM partitioning can be thought of in two parts. First there is configuring the distribution of VDOMs between
two virtual clusters. By default, all VDOMS are in virtual cluster 1 and virtual cluster 1 is associated with the
primary FortiGate. In this configuration, the primary FortiGate processes all traffic. If you want traffic to be
processed by the backup FortiGate, you need to enable virtual cluster 2, move some of the VDOMs to it, and
associate virtual cluster 2 with the backup FortiGate.

Since there are only two virtual clusters, even in a virtual clustering configuration of
three or four FortiGates only two of the FortiGates process traffic. The third and fourth
FortiGates operate in standby mode and process traffic after a failover.

By default all VDOMS are in virtual cluster 1 and the primary FortiGate processes all traffic.

You associate a virtual cluster with a FortiGate using priorities. The FortiGate with the highest device priority is
associated with virtual cluster 1. To associate a FortiGate with virtual cluster 2 you must enable virtual cluster 2
and set the virtual cluster 2 device priority. The FortiGate with the highest virtual cluster 2 device priority
processes traffic for the VDOMs added to virtual cluster 2. (Reminder: device priorities are not synchronized.)

If both FortiGates have the same device priority, virtual cluster 1 is associated with the
primary FortiGate. If both FortiGates have the same virtual cluster 2 device priority,
virtual cluster 2 is associated with the primary FortiGate.
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Virtual clustering and the override setting

Enabling virtual cluster 2 also turns on the HA override setting. Enabling override is required for virtual clustering
to function as configured. Enabling override causes the cluster to negotiate every time a failure occurs. If override
is not enabled, the cluster will not negotiate after all failures. While more frequent negotiation may cause more
minor traffic disruptions, with virtual clustering its more important to negotiate after any failure to make sure the
correct traffic flows are maintained.

Example virtual clustering configuration

For example, consider a configuration that includes four VDOMs: root, Engineering, Marketing, and Finance. You
can use the following configuration to send root and Engineering traffic to the primary FortiGate and Marketing
and Finance traffic to the backup FortiGate.

First, on the primary FortiGate:

l Set the device priority to 200
l Enable virtual cluster 2 (vcluster2)
l Set the virtual cluster 2 device priority (secondary-vcluster) to 50
l Add the Marketing and Finance VDOMs to virtual cluster 2 (secondary-vcluster)

When you enable multiple VDOMs, virtual cluster 2 is enabled by default. Even so the
command to enable virtual cluster 2 is included in this example in case for some
reason it has been disabled. Enabling virtual cluster 2 also enables override.

config global
config system ha

set mode a-p
set group-name mygroup
set password <password>
set priority 200
set vcluster2 enable
config secondary-vcluster

set vdom Marketing Finance
set priority 50

end
end

Then on the backup FortiGate:

l Set the device priority to 50 (lower than the primary FortiGate)
l Enable virtual cluster 2 (vcluster2)
l Set the virtual cluster 2 device priority (secondary-vcluster) to 200 (higher than the primary FortiGate).

config global
config system ha

set mode a-p
set group-name mygroup
set password <password>
set priority 50
set vcluster2 enable
config secondary-vcluster

set priority 200
end

end
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Since the primary FortiGate has the highest device priority, the primary unit processes
all traffic for the VDOMs in virtual cluster 1. Since the backup FortiGate has the
highest virtual cluster 2 device priority, the backup FortiGate processes all traffic for
the VDOMs in virtual cluster 2. The primary FortiGate configuration adds the VDOMs
to virtual cluster 2. All you have to configure on the backup FortiGate for virtual cluster
2 is the virtual cluster 2 (or secondary-vcluster) device priority.

Adding a third FortiGate to the virtual cluster

You can add a third FortiGate to the virtual cluster and configure it so that if the primary FortiGate fails, the third
FortiGate becomes the new primary FortiGate or if the backup FortiGate fails, the third FortiGate becomes the
new backup FortiGate.

On the third FortiGate:

l Set the device priority to 150 (lower than the primary FortiGate but higher than the backup FortiGate)
l Enable virtual cluster 2 (vcluster2)
l Set the virtual cluster 2 device priority (secondary-vcluster) to 100 (higher than the primary FortiGate but lower than

the backup FortiGate)

config global
config system ha

set mode a-p
set group-name mygroup
set password <password>
set priority 150
set vcluster2 enable
config secondary-vcluster

set priority 100
end

end

Adding a fourth FortiGate to the virtual cluster

You can add a fourth FortiGate to the virtual cluster and configure it so that:

l If the primary FortiGate fails, the third FortiGate becomes the new primary FortiGate, the backup FortiGate
continues to operate as the backup FortiGate.

l If the backup FortiGate fails, the fourth FortiGate becomes the new backup FortiGate.
l If both the primary and backup FortiGates fail, the third FortiGate becomes the primary FortiGate and the fourth

FortiGate becomes the backup FortiGate.

On the fourth FortiGate:

l Set the device priority to 100 (lower than the primary and third FortiGate but higher than the backup FortiGate)
l Enable virtual cluster 2 (vcluster2)
l Set the virtual cluster 2 device priority (secondary-vcluster) to 150 (higher than the primary FortiGate and the third

FortiGate but lower than the backup FortiGate)

config global
config system ha

set mode a-p
set group-name mygroup
set password <password>
set priority 100
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set vcluster2 enable
config secondary-vcluster

set priority 150
end

end

Virtual clustering with four FortiGates recommended configuration

As described in the previous sections, here is a recommended device priority configuration for a virtual cluster
consisting of four FortiGates. Other configurations are also supported depending on how you want the virtual
cluster to respond to a failure.

FortiGate Device Priority Virtual Cluster 2 Device Priority

Primary 200 50

Backup 50 100

Third 150 200

Fourth 100 150

Virtual clustering GUI configuration

From the GUI, you configure virtual clustering from the Global menu by going to System > HA setting theMode
to Active-Passive and enabling VDOM Partitioning.
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Example primary FortiGate virtual clustering configuration

Virtual clustering configuration examples
See the following cookbook recipe for a virtual clustering configuration example. This example shows how to set
up a virtual cluster of two FortiGates and then how to add a third and fourth FortiGate to the virtual cluster
configuration.
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l FGCP virtual clustering with two FortiGates
l FGCP virtual clustering with two FortiGates

Example inter-VDOM links in a virtual clustering configuration
In a virtual domain configuration you can use inter-VDOM links to route traffic between two virtual domains
operating in a single FortiGate without using physical interfaces. Adding an inter-VDOM link has the affect of
adding two interfaces to the FortiGate and routing traffic between the virtual domains using the inter-VDOM link
interfaces.

In a virtual clustering configuration inter-VDOM links can only be made between virtual domains that are in the
same virtual cluster. So, if you are planning on configuring inter-VDOM links in a virtual clustering configuration,
you should make sure the virtual domains that you want to link are in the same virtual cluster.

For example, the following tables show an example virtual clustering configuration where each virtual cluster
contains four virtual domains. In this configuration you can configure inter-VDOM links between root and vdom_1
and between vdom_2 and vdom_3. But, you cannot configure inter-VDOM links between root and vdom_2 or
between vdom_1 and vdom_3 (and so on).

Virtual Domains

Hostname

FortiGate_A FortiGate_B

root Priority

200

Priority

100

vdom_1
Role

Primary

Role

Subordinate

Virtual Domains

Hostname

FortiGate_A FortiGate_B

vdom_2 Priority

100

Priority

200

vdom_3
Role

Subordinate

Role

Primary

Configuring inter-VDOM links in a virtual clustering configuration

Configuring inter-VDOM links in a virtual clustering configuration is very similar to configuring inter-VDOM links
for a standalone FortiGate. The main difference the config system vdom-link command includes the
vcluster keyword. The default setting for vcluster is vcluster1. So you only have to use the vcluster
keyword if you are added an inter-VDOM link to virtual cluster 2.
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To add an inter-VDOM link to virtual cluster 1

This procedure describes how to create an inter-VDOM link to virtual cluster 1 that results in a link between the
root and vdom_1 virtual domains.

Inter-VDOM links are also called internal point-to-point interfaces.

1. Add an inter-VDOM link called vc1link.
config global

config system vdom-link
edit vc1link

end

Adding the inter-VDOM link also adds two interfaces. In this example, these interfaces are called
vc1link0 and vc1link1. These interfaces appear in all CLI and GUI interface lists. These
interfaces can only be added to virtual domains in virtual cluster 1.

2. Bind the vc1link0 interface to the root virtual domain and bind the vc1link1 interface to the vdom_1 virtual
domain.

config system interface
edit vc1link0

set vdom root
next
edit vc1link1

set vdom vdom_1
end

To add an inter-VDOM link to virtual cluster 2

This procedure describes how to create an inter-VDOM link to virtual cluster 2 that results in a link between the
vdom_2 and vdom_3 virtual domains.

1. Add an inter-VDOM link called vc2link.
config global

config system vdom-link
edit vc2link

set vcluster vcluster2
end

Adding the inter-VDOM link also adds two interfaces. In this example, these interfaces are called
vc2link0 and vc2link1. These interfaces appear in all CLI and GUI interface lists. These
interfaces can only be added to virtual domains in virtual cluster 2.

2. Bind the vc2link0 interface to the vdom_2 virtual domain and bind the vc2link1 interface to the vdom_3
virtual domain.

config system interface
edit vc2link0

set vdom vdom_2
next
edit vc2link1

set vdom vdom_3
end
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Troubleshooting virtual clustering
Troubleshooting virtual clusters is similar to troubleshooting any cluster (see FGCP configuration examples and
troubleshooting on page 1771). This section describes a few testing and troubleshooting techniques for virtual
clustering.

To test the VDOM partitioning configuration

You can do the following to confirm that traffic for different VDOMs will be distributed among both FortiGates in
the virtual cluster. These steps assume the cluster is otherwise operating correctly.

1. Log into the GUI or CLI using the IP addresses of interfaces in each VDOM.
Confirm that you have logged into the FortiGate that should be processing traffic for that VDOM by
checking the HTML title displayed by your web browser or the CLI prompt. Both of these should
include the host name of the cluster unit that you have logged into. Also on the system Dashboard,
the System Information widget displays the serial number of the FortiGate that you logged into. From
the CLI the get system status command displays the status of the cluster unit that you logged
into.

2. To verify that the correct cluster unit is processing traffic for a VDOM:
l Add security policies to the VDOM that allow communication between the interfaces in the VDOM.
l Optionally enable traffic logging and other monitoring for that VDOM and these security policies.
l Start communication sessions that pass traffic through the VDOM.
l Log into the GUI and go to System > HA. Verify that the statistics display showsmore active sessions, total

packets, network utilization, and total bytes for the unit that should be processing all traffic for the VDOM.
l Optionally check traffic logging and the Top SessionsWidget for the FortiGate that should be processing traffic

for that VDOM to verify that the traffic is being processed by this FortiGate.
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This chapter provides an introduction to full mesh HA and also contains general procedures and configuration
examples that describe how to configure FortiGate full mesh HA.

The examples in this chapter include example values only. In most cases you will substitute your own values. The
examples in this chapter also do not contain detailed descriptions of configuration parameters.

Full mesh HA overview
When two or more FortiGates are connected to a network in an HA cluster the reliability of the network is
improved because the HA cluster replaces a single FortiGate as a single point of failure. With a cluster, a single
FortiGate is replaced by a cluster of two or more FortiGates.

However, even with a cluster, potential single points of failure remain. The interfaces of each cluster unit connect
to a single switch and that switch provides a single connection to the network. If the switch fails or if the
connection between the switch and the network fails service is interrupted to that network.

The HA cluster does improve the reliability of the network because switches are not as complex components as
FortiGates, so are less likely to fail. However, for even greater reliability, a configuration is required that includes
redundant connections between the cluster the networks that it is connected to.

FortiGate models that support 802.3ad Aggregate or Redundant interfaces can be used to create a cluster
configuration called full mesh HA. Full mesh HA is a method of reducing the number of single points of failure on
a network that includes an HA cluster.

This redundant configuration can be achieved using FortiGate 802.3ad Aggregate or Redundant interfaces and a
full mesh HA configuration. In a full mesh HA configuration, you connect an HA cluster consisting of two or more
FortiGates to the network using 802.3ad Aggregate or Redundant interfaces and redundant switches. Each
802.3ad Aggregate or Redundant interface is connected to two switches and both of these switches are
connected to the network. In addition you must set up an IEEE 802.1Q (also called Dot1Q) or ISL link between
the redundant switches connected to the Aggregate or Redundant interfaces.

The resulting full mesh configuration, an example is shown below, includes redundant connections between all
network components. If any single component or any single connection fails, traffic automatically switches to the
redundant component and connection and traffic flow resumes.
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Single points of failure in a standalone and HA network configuration

Full mesh HA and redundant heartbeat interfaces

A full mesh HA configuration also includes redundant HA heartbeat interfaces. At least two heartbeat interfaces
should be selected in the HA configuration and both sets of HA heartbeat interfaces should be connected. The HA
heartbeat interfaces do not have to be configured as redundant interfaces because the FGCP handles failover
between heartbeat interfaces.

Full mesh HA, redundant interfaces and 802.3ad aggregate interfaces

Full mesh HA is supported for both redundant interfaces and 802.3ad aggregate interfaces. In most cases you
would simply use redundant interfaces. However, if your switches support 802.3ad aggregate interfaces and split
multi-trunking you can use aggregate interfaces in place of redundant interfaces for full mesh HA. One advantage
of using aggregate interfaces is that all of the physical interfaces in the aggregate interface can send and receive
packets. As a result, using aggregate interfaces may increase the bandwidth capacity of the cluster.

Usually redundant and aggregate interfaces consist of two physical interfaces. However, you can add more than
two physical interfaces to a redundant or aggregate interface. Adding more interfaces can increase redundancy
protection. Adding more interfaces can also increase bandwidth capacity if you are using 802.3ad aggregate
interfaces.
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Example full mesh HA configuration
The following figure shows a full mesh HA configuration with a cluster of two FortiGates. This section describes
the FortiGate configuration settings and network components required for a full mesh HA configuration. This
section also contains example steps for setting up this full mesh HA configuration. The procedures in this section
describe one of many possible sequences of steps for configuring full mesh HA. As you become more
experienced with FortiOS, HA, and full mesh HA you may choose to use a different sequence of configuration
steps.

Full Mesh HA configuration

For simplicity these procedures assume that you are starting with two new FortiGates set to the factory default
configuration. However, starting from the default configuration is not a requirement for a successful HA
deployment. FortiGate HA is flexible enough to support a successful configuration from many different starting
points.

These procedures describe how to configure a cluster operating in NAT mode because NAT is the default
FortiGate operating mode. However, the steps are the same if the cluster operates in transparent mode. You can
either switch the cluster units to operate in transparent mode before beginning these procedures, or you can
switch the cluster to operate in transparent mode after HA is configured and the cluster is connected and
operating.
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Full mesh HA configuration

The two FortiGates (FGT_ha_1 and FGT_ha_2) can be operating in NAT or transparent mode. Aside from the
standard HA settings, the FortiGate configuration includes the following:

l The port5 and port6 interfaces configured as heartbeat interfaces. A full mesh HA configuration also includes
redundant HA heartbeat interfaces.

l The port1 and port2 interfaces added to a redundant interface. Port1 is the active physical interface in this
redundant interface. To make the port1 interface the active physical interface it should appear above the port2
interface in the redundant interface configuration.

l The port3 and port4 interfaces added to a redundant interface. Port3 is the active physical interface in this
redundant interface. To make the port3 interface the active physical interface it should appear above the port4
interface in the redundant interface configuration.

Full mesh switch configuration

The following redundant switch configuration is required:

l Two redundant switches (Sw3 and Sw4) connected to the internal network. Establish an 802.1Q (Dot1Q) or
interswitch-link (ISL) connection between them.

l Two redundant switches (Sw1 and Sw2) connected to the Internet. Establish an 802.1Q (Dot1Q) or interswitch-link
(ISL) connection between them.

Full mesh network connections

Make the following physical network connections for FGT_ha_1:

l Port1 to Sw1 (active)
l Port2 to Sw2 (inactive)
l Port3 to Sw3 (active)
l Port4 to Sw4 (inactive)

Make the following physical network connections for FGT_ha_2:

l Port1 to Sw2 (active)
l Port2 to Sw1 (inactive)
l Port3 to Sw4 (active)
l Port4 to Sw3 (inactive)

How packets travel from the internal network through the full mesh cluster and to the Internet

If the cluster is operating in active-passive mode and FGT_ha_2 is the primary unit, all packets take the following
path from the internal network to the internet:

1. From the internal network to Sw4. Sw4 is the active connection to FGT_ha_2; which is the primary unit. The
primary unit receives all packets.

2. From Sw4 to the FGT_ha_2 port3 interface. Active connection between Sw4 and FGT_ha_2. Port3 is the active
member of the redundant interface.

3. From FGT_ha_2 port3 to FGT_ha_2 port1. Active connection between FGT_ha_2 and Sw2. Port1 is the active
member of the redundant interface.

4. From Sw2 to the external router and the Internet.
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Configuring full-mesh HA - GUI

Each cluster unit must have the same HA configuration.

To configure the FortiGates for HA operation

1. Register and apply licenses to the FortiGate.

2. On the System Information dashboard widget, beside Host Name select Change.
3. Enter a new Host Name for this FortiGate.

New Name FGT_ha_1

4. Go toSystem > HA and change the following settings.

Mode Active-Active

Group Name Rexample1.com

Password RHA_pass_1

Heartbeat Interface

Enable Priority

port5 Select 50

port6 Select 50

5. Select OK.
The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
connectivity with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address
of the FortiGate interfaces. The MAC addresses of the FortiGate interfaces change to the following
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virtual MAC addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-0b
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0e
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

To be able to reconnect sooner, you can update the ARP table of your management PC by deleting
the ARP table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete
the arp table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
MAC: 00:09:0f:09:00:00
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

6. Power off the first FortiGate.
7. Repeat these steps for the second FortiGate.

Set the second FortiGate host name to:

New Name FGT_ha_2
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To connect the cluster to your network

1. Make the following physical network connections for FGT_ha_1:
l Port1 to Sw1 (active)
l Port2 to Sw2 (inactive)
l Port3 to Sw3 (active)
l Port4 to Sw4 (inactive)

2. Make the following physical network connections for FGT_ha_2:
l Port1 to Sw2 (active)
l Port2 to Sw1 (inactive)
l Port3 to Sw4 (active)
l Port4 to Sw3 (inactive)

3. Connect Sw3 and Sw4 to the internal network.
4. Connect Sw1 and Sw2 to the external router.
5. Enable 802.1Q (Dot1Q) or ISL communication between Sw1 and Sw2 and between Sw3 and Sw4.
6. Power on the cluster units.

The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention.

When negotiation is complete the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view the cluster dashboard and cluster members list to confirm that the cluster units
are operating as a cluster.

1. View the system dashboard.
The System Information dashboard widget shows the Cluster Name (Rexample1.com) and the host
names and serial numbers of the Cluster Members. The Unit Operation widget shows multiple
cluster units.

2. Go to System > HA to view the cluster members list.
The list shows two cluster units, their host names, their roles in the cluster, and their priorities. You
can use this list to confirm that the cluster is operating normally.

To troubleshoot the cluster configuration

If the cluster members list and the dashboard does not display information for both cluster units the FortiGates
are not functioning as a cluster. See Example full mesh HA configuration on page 1862 to troubleshoot the
cluster.

To add basic configuration settings and the redundant interfaces

Use the following steps to add a few basic configuration settings.

1. Log into the cluster GUI.
2. Go to System > Administrators.
3. Edit admin and select Change Password.
4. Enter and confirm a new password.
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5. Select OK.
6. Go to Network > Static Routes and temporarily delete the default route.

You cannot add an interface to a redundant interface if any settings (such as the default route) are
configured for it.

7. Go to Network > Interfaces and select Create New > Interface and configure the redundant interface to
connect to the Internet.

Name Port1_Port2

Type Redundant

Physical Interface Members

Selected Interfaces port1, port2

IP/Netmask 172.20.120.141/24

8. Select OK.
9. Select Create New and configure the redundant interface to connect to the internal network.

Name Port3_Port4

Type Redundant

Physical Interface Members

Selected Interfaces port3, port4

IP/Netmask 10.11.101.100/24

Administrative Access HTTPS, PING, SSH

10. Select OK.
The virtual MAC addresses of the FortiGate interfaces change to the following. Notice that port1 and
port2 both have the port1 virtual MAC address and port3 and port4 both have the port3 virtual MAC
address:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-00 (same as port1)
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l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0d (same as port3)
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

11. Go to Router > Static > Static Routes.
12. Add the default route.

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.2

Device Port1_Port2

Distance 10

13. Select OK.

To configure HA port monitoring for the redundant interfaces

1. Go to System > HA.
2. In the cluster members list, edit the primary unit.
3. Enable interface monitoring the Port1_Port2 and the Port3_Port4 interfaces
4. Select OK.

Configuring full mesh HA - CLI

Each cluster must have the same HA configuration. Use the following procedure to configure the FortiGates for
HA operation.

To configure the FortiGates for HA operation

1. Register and apply licenses to the FortiGate.
2. Enter a new Host Name for this FortiGate.

config system global
set hostname FGT_ha_1

end

3. Configure HA settings.
config system ha

set mode a-a
set group-name Rexample1.com
set password RHA_pass_1
set hbdev port5 50 port6 50

end

The FortiGate negotiates to establish an HA cluster. When you select OK you may temporarily lose
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connectivity with the FortiGate as the HA cluster negotiates and the FGCP changes the MAC address
of the FortiGate interfaces. The MAC addresses of the FortiGate interfaces change to the following
virtual MAC addresses:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-0b
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0e
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

To be able to reconnect sooner, you can update the ARP table of your management PC by deleting
the ARP table entry for the FortiGate (or just deleting all arp table entries). You may be able to delete
the arp table of your management PC from a command prompt using a command similar to arp -d.

You can use the get hardware nic (or diagnose hardware deviceinfo nic) CLI
command to view the virtual MAC address of any FortiGate interface. For example, use the following
command to view the port1 interface virtual MAC address (Current_HWaddr) and the port1
permanent MAC address (Permanent_HWaddr):

get hardware nic port1
.
.
.
MAC: 00:09:0f:09:00:00
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

4. Power off the first FortiGate.
5. Repeat these steps for the second FortiGate.

Set the other FortiGate host name to:

config system global
set hostname FGT_ha_2

end
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To connect the cluster to your network

1. Make the following physical network connections for FGT_ha_1:
l Port1 to Sw1 (active)
l Port2 to Sw2 (inactive)
l Port3 to Sw3 (active)
l Port4 to Sw4 (inactive)

2. Make the following physical network connections for FGT_ha_2:
l Port1 to Sw2 (active)
l Port2 to Sw1 (inactive)
l Port3 to Sw4 (active)
l Port4 to Sw3 (inactive)

3. Connect Sw3 and Sw4 to the internal network.
4. Connect Sw1 and Sw2 to the external router.
5. Enable 802.1Q (Dot1Q) or ISL communication between Sw1 and Sw2 and between Sw3 and Sw4.
6. Power on the cluster units.

The units start and negotiate to choose the primary unit and the subordinate unit. This negotiation
occurs with no user intervention.

When negotiation is complete the cluster is ready to be configured for your network.

To view cluster status

Use the following steps to view cluster status from the CLI.

1. Log into the CLI.
2. Enter get system status to verify the HA status of the cluster unit that you logged into.

If the command output includes Current HA mode: a-a, master, the cluster units are
operating as a cluster and you have connected to the primary unit.

If the command output includes Current HA mode: a-a, backup, you have connected to a
subordinate unit.

If the command output includes Current HA mode: standalone the cluster unit is not
operating in HAmode.

3. Enter the following command to confirm the HA configuration of the cluster:

get system ha status
HA Health Status: OK
Model: FortiGate-XXXX
Mode: HA A-P
Group: 0
Debug: 0
Cluster Uptime: 7 days 00:30:26
.
.
.

You can use this command to confirm that the cluster is healthy and operating normally, some
information about the cluster configuration, and information about how long the cluster has been
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operating. Information not shown in this example includes how the primary unit was selected,
configuration synchronization status, usage stats for each cluster unit, heartbeat status, and the
relative priorities of the cluster units.

4. Use the execute ha manage command to connect to the other cluster unit’s CLI and use these commands to
verify cluster status.

To troubleshoot the cluster configuration

If the cluster members list and the dashboard does not display information for both cluster units the FortiGates
are not functioning as a cluster. See Example full mesh HA configuration on page 1862 to troubleshoot the
cluster.

To add basic configuration settings and the redundant interfaces

Use the following steps to add a few basic configuration settings. Some steps use the CLI and some the GUI.

1. Log into the cluster CLI.
2. Add a password for the admin administrative account.

config system admin
edit admin

set password <password_str>
end

3. Temporarily delete the default route.
You cannot add an interface to a redundant interface if any settings (such as the default route) are
configured for it.

config router static
delete 1

end

4. Go to System > Network > Interface and select Create New to add the redundant interface to connect to the
Internet.

5. Add the redundant interface to connect to the Internet.
config system interface

edit Port1_Port2
set type redundant
set member port1 port2

end

6. Add the redundant interface to connect to the internal network.
config system interface

edit Port3_Port4
set type redundant
set member port3 port4

end

The virtual MAC addresses of the FortiGate interfaces change to the following. Note that port1 and
port2 both have the port1 virtual MAC address and port3 and port4 both have the port3 virtual MAC
address:

l port1 interface virtual MAC: 00-09-0f-09-00-00
l port10 interface virtual MAC: 00-09-0f-09-00-01
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l port11 interface virtual MAC: 00-09-0f-09-00-02
l port12 interface virtual MAC: 00-09-0f-09-00-03
l port13 interface virtual MAC: 00-09-0f-09-00-04
l port14 interface virtual MAC: 00-09-0f-09-00-05
l port15 interface virtual MAC: 00-09-0f-09-00-06
l port16 interface virtual MAC: 00-09-0f-09-00-07
l port17 interface virtual MAC: 00-09-0f-09-00-08
l port18 interface virtual MAC: 00-09-0f-09-00-09
l port19 interface virtual MAC: 00-09-0f-09-00-0a
l port2 interface virtual MAC: 00-09-0f-09-00-00 (same as port1)
l port20 interface virtual MAC: 00-09-0f-09-00-0c
l port3 interface virtual MAC: 00-09-0f-09-00-0d
l port4 interface virtual MAC: 00-09-0f-09-00-0d (same as port3)
l port5 interface virtual MAC: 00-09-0f-09-00-0f
l port6 interface virtual MAC: 00-09-0f-09-00-10
l port7 interface virtual MAC: 00-09-0f-09-00-11
l port8 interface virtual MAC: 00-09-0f-09-00-12
l port9 interface virtual MAC: 00-09-0f-09-00-13

7. Go to Router > Static > Static Routes.
8. Add the default route.

config router static
edit 1

set dst 0.0.0.0 0.0.0.0
set gateway 172.20.120.2
set device Port1_Port2

end

To configure HA port monitoring for the redundant interfaces

1. Enter the following command to configure port monitoring for the redundant interfaces:
config system ha

set monitor Port1_Port2 Port3_Port4
end

Troubleshooting full mesh HA
Troubleshooting full mesh HA clusters is similar to troubleshooting any cluster (see FGCP configuration examples
and troubleshooting on page 1771 or Virtual clusters on page 1850). The configuration and operation of a full
mesh HA cluster is very similar to the configuration and operation of a standard cluster. The only differences
relate to the configuration, connection, and operation of the redundant interfaces and redundant switches.

l Make sure the redundant interfaces and switches are connected correctly. With so many connections it is possible
to make mistakes or for cables to become disconnected.

l Confirm that the configuration of the cluster unit 802.3ad Aggregate or Redundant interfaces is correct according to
the configuration procedures in this chapter.

l In some configurations with some switch hardware, MAC-learning delays on the inter-switch links on the
surrounding topologies may occur. The delays occur if the gratuitous ARP packets sent by the cluster after a failover
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are delayed by the switches before being sent across the inter-switch link. If this happens the surrounding
topologies may be delayed in recognizing the failover and will keep sending packets to the MAC address of the
failed primary unit resulting in lost traffic. Resolving this problem may require changing the configuration of the
switch or replacing them with switch hardware that does not delay the gratuitous ARP packets.
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With some exceptions, you can operate a cluster in much the same way as you operate a standalone FortiGate.
This chapter describes those exceptions and also the similarities involved in operating a cluster instead of a
standalone FortiGate.

Operating a cluster
The configurations of all of the FortiGates in a cluster are synchronized so that the cluster units can simulate a
single FortiGate. Because of this synchronization, you manage the HA cluster instead of managing the individual
cluster units. You manage the cluster by connecting to the GUI using any cluster interface configured for HTTPS
or HTTP administrative access. You can also manage the cluster by connecting to the CLI using any cluster
interface configured for SSH or telnet administrative access.

The cluster GUI dashboard displays the cluster name, the host name and serial number of each cluster member,
and also shows the role of each unit in the cluster. The roles can be master (primary unit) and slave (subordinate
units). The dashboard also displays a cluster unit front panel illustration.

You can also go to System > HA to view the cluster members list. This includes status information for each
cluster unit. You can also use the cluster members list for a number of cluster management functions including
changing the HA configuration of an operating cluster, changing the host name and device priority of a
subordinate unit, and disconnecting a cluster unit from a cluster. See Cluster members list on page 1892.

You can use log messages to view information about the status of the cluster. See Clusters and logging on page
1884.

You can use SNMP to manage the cluster by configuring a cluster interface for SNMP administrative access.
Using an SNMPmanager you can get cluster configuration information and receive traps. See Clusters and
SNMP on page 1887.

You can configure a reserved management interface to manage individual cluster units. You can use this
interface to access the GUI or CLI and to configure SNMPmanagement for individual cluster units. See
Managing individual cluster units using a reserved out-of-band management interface on page 1875.

You can manage individual cluster units by using SSH, telnet, or the CLI console on the GUI dashboard to
connect to the CLI of the cluster. From the CLI you can use the execute ha manage command to connect to
the CLI of any unit in the cluster.

You can also manage individual cluster units by using a null-modem cable to connect to any cluster unit CLI.
From there you can use the execute ha manage command to connect to the CLI of each unit in the cluster.

Operating a virtual cluster
Managing a virtual cluster is very similar to managing a cluster that does not contain multiple virtual domains.
Most of the information in this chapter applies to managing both kinds of clusters. This section describes what is
different when managing a virtual cluster.

If virtual domains are enabled, the cluster GUI dashboard displays the cluster name and the role of each cluster
unit in virtual cluster 1 and virtual cluster 2.

The configuration and maintenance options that you have when you connect to a virtual cluster GUI or CLI
depend on the virtual domain that you connect to and the administrator account that you use to connect.

1874 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 15 - High Availability Operating clusters and virtual clusters

If you connect to a cluster as the administrator of a virtual domain, you connect directly to the virtual domain.
Since HA virtual clustering is a global configuration, virtual domain administrators cannot see HA configuration
options. However, virtual domain administrators see the host name of the cluster unit that they are connecting to
on the web browser title bar or CLI prompt. This host name is the host name of the primary unit for the virtual
domain. Also, when viewing log messages the virtual domain administrator can select to view log messages for
either of the cluster units.

If you connect to a virtual cluster as the admin administrator you connect to the global GUI or CLI. Even so, you
are connecting to an interface and to the virtual domain that the interface has been added to. The virtual domain
that you connect to does not make a difference for most configuration and maintenance operations. However,
there are a few exceptions. You connect to the FortiGate that functions as the primary unit for the virtual domain.
So the host name displayed on the web browser title bar and on the CLI is the host name of this primary unit.

Managing individual cluster units using a reserved out-of-band management interface
You can provide direct management access to all cluster units by reserving up to four management interfaces as
part of the HA configuration. Once a management interface is reserved, you can configure a different IP address,
administrative access and other interface settings for each management interface for each cluster unit. Then by
connecting these interfaces of each cluster unit to your network you can manage each cluster unit separately from
different IP addresses. Configuration changes to the reserved management interfaces are not synchronized to
other cluster units.

You can also configure and in-band management interface for a cluster unit. See
"Managing individual cluster units using an in-band management IP address" on page
1881.

Reserved management interfaces provide direct management access to each cluster unit and give each cluster
unit a different identity on your network. This simplifies using external services, such as SNMP, to separately
monitor and manage each cluster unit.

The reserved management interfaces are not assigned HA virtual MAC addresses like
other cluster interfaces. Instead the reserved management interfaces retain the
permanent hardware address of the physical interface unless you change it using the
config system interface command.

Reserved management interfaces and their IP addresses should not be used for managing a cluster using
FortiManager. To correctly manage a FortiGate HA cluster with FortiManager use the IP address of one of the
cluster unit interfaces.

If you enable SNMP administrative access for a reserved management interface you can use SNMP to monitor
each cluster unit using the reserved management interface IP address. To monitor each cluster unit using SNMP,
just add the IP address of each cluster unit’s reserved management interface to the SNMP server configuration.
You must also enable direct management of cluster members in the cluster SNMP configuration.

If you enable HTTPS or HTTP administrative access for the reserved management interfaces you can connect to
the GUI of each cluster unit. Any configuration changes made to any of the cluster units is automatically
synchronized to all cluster units. From the subordinate units the GUI has the same features as the primary unit
except that unit-specific information is displayed for the subordinate unit, for example:

l The Dashboard System Information widget displays the subordinate unit serial number but also displays the
same information about the cluster as the primary unit
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l On the Cluster members list (go to System > HA) you can change the HA configuration of the subordinate unit that
you are logged into. For the primary unit and other subordinate units you can change only the host name and device
priority.

l Log Access displays the logs of the subordinate that you are logged into fist, You use the HACluster list to view the
log messages of other cluster units including the primary unit.

If you enable SSH or TELNET administrative access for the reserved management interfaces you can connect to
the CLI of each cluster unit. The CLI prompt contains the host name of the cluster unit that you have connected
to. Any configuration changes made to any of the cluster units is automatically synchronized to all cluster units.
You can also use the execute ha manage command to connect to other cluster unit CLIs.

The reserved management interface is available in NAT and in transparent mode. It is also available if the cluster
is operating with multiple VDOMs. In transparent mode you cannot normally add an IP address to an interface.
However, you can add an IP address to the reserved management interface.

Reserved management interface for FortiSandbox, SNMP, and RADIUS

By default, management services such as SNMP, remote logging, remote authentication and so on use a cluster
interface. As a result, communication from each cluster unit comes from a cluster interface instead of from the
interface of an individual cluster unit and not from the HA reserved management interface.

If you want to use an HA reserved management interface for these management features you must enter the
following command:

config system ha
set ha-direct enable

end

By enabling ha-direct, the following management features will use the HA reserved management interface:

l Remote logging (including syslog, FortiAnalyzer, and FortiCloud).
l SNMP queries and traps.
l RADIUS remote authentication.
l Communication with FortiSandbox.

This means that individual cluster units send log messages and communicate with FortiSandbox and so on using
their HA reserved management interface instead of one of the cluster interfaces. This allows you to manage each
cluster unit separately and to separate the management traffic from each cluster unit. This can also be useful if
each cluster unit is in a different location.

If you just want to use HA reserved management interfaces for SNMP remote management you can enable ha-
direct in the SNMP configuration as shown in the following section.

Configuring the reserved management interface and SNMP remote management of individual
cluster units

This example describes how to configure SNMP remote management of individual cluster units using an HA
reserved management interface. The configuration consists of two FortiGate-620B units already operating as a
cluster. In the example, the port8 interface of each cluster unit is connected to the internal network using the
switch and configured as the reserved management interface.
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SNMP remote management of individual cluster units

To configure the reserved management interface - GUI

From the GUI you can also configure IPv4 and IPv6 default routes that are only used by the reserved
management interface.

1. Go to System > HA.
2. Edit the primary unit.
3. Select Management Interface Reservation and select port8.
4. Set Gateway to 10.11.101.2.
5. Set IPv6 Gateway to 2001:db8:0:2::20
6. Select OK.

To configure the reserved management interface - CLI

From the CLI you can also configure IPv4 and IPv6 default routes that are only used by the reserved
management interface.

1. Log into the CLI of any cluster unit.
2. Enter the following command to enable the reserved management interface, set port8 as the reserved interface,

and add an IPv4 default route of 10.11.101.2 and an IPv6 default route of 2001:db8:0:2::20 for the reserved
management interface.

config system ha
set ha-mgmt-status enable
config ha-mgmt-interfaces

edit 1
set interface port8
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set gateway 10.11.101.2
set gateway6 2001:db8:0:2::20

end

The reserved management interface default route is not synchronized to other cluster units.

To change the primary unit reserved management interface configuration - GUI

You can change the IP address of the primary unit reserved management interface from the primary unit GUI.
Configuration changes to the reserved management interface are not synchronized to other cluster units.

1. From a PC on the internal network, browse to http://10.11.101.100 and log into the cluster GUI.
This logs you into the primary unit GUI.

You can identify the primary unit from its serial number or host name that appears on the System
Information dashboard widget.

2. Go to Network > Interfaces and edit the port8 interface as follows:

Alias primary_reserved

IP/Netmask 10.11.101.101/24

Administrative Access Ping, SSH, HTTPS, SNMP

3. Select OK.
You can now log into the primary unit GUI by browsing to https://10.11.101.101. You can also log into
this primary unit CLI by using an SSH client to connect to 10.11.101.101.

To change subordinate unit reserved management interface configuration - CLI

At this point you cannot connect to the subordinate unit reserved management interface because it does not have
an IP address. Instead, this procedure describes connecting to the primary unit CLI and using the execute ha
manage command to connect to subordinate unit CLI to change the port8 interface. You can also use a serial
connection to the cluster unit CLI. Configuration changes to the reserved management interface are not
synchronized to other cluster units.

1. Connect to the primary unit CLI and use the execute ha manage command to connect to a subordinate unit
CLI.
You can identify the subordinate unit from is serial number or host name. The host name appears in
the CLI prompt.

2. Enter the following command to change the port8 IP address to 10.11.101.102 and set management access
to HTTPS, ping, SSH, and SNMP.

config system interface
edit port8

set ip 10.11.101.102/24
set allowaccess https ping ssh snmp

end

You can now log into the subordinate unit GUI by browsing to https://10.11.101.102. You can also log
into this subordinate unit CLI by using an SSH client to connect to 10.11.101.102.
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To configure the cluster for SNMP management using the reserved management interfaces - CLI

This procedure describes how to configure the cluster to allow the SNMP server to get status information from the
primary unit and the subordinate unit. The SNMP configuration is synchronized to all cluster units. To support
using the reserved management interfaces, you must add at least one HA direct management host to an SNMP
community. If your SNMP configuration includes SNMP users with user names and passwords you must also
enable HA direct management for SNMP users.

1. Enter the following command to add an SNMP community called Community and add a host to the community
for the reserved management interface of each cluster unit. The host includes the IP address of the SNMP server
(10.11.101.20).

config system snmp community
edit 1

set name Community
config hosts

edit 1
set ha-direct enable
set ip 10.11.101.20

end
end

Enabling ha-direct in non-HA environments makes SNMP unusable.

2.
3. Enter the following command to add an SNMP user for the reserved management interface.

config system snmp user
edit 1

set ha-direct enable
set notify-hosts 10.11.101.20

end

Configure other settings as required.

To get CPU, memory, and network usage of each cluster unit using the reserved management IP
addresses

From the command line of an SNMPmanager, you can use the following SNMP commands to get CPU, memory
and network usage information for each cluster unit. In the examples, the community name is Community. The
commands use the MIB field names and OIDs listed below.

Enter the following commands to get CPU, memory and network usage information for the primary unit with
reserved management IP address 10.11.101.101 using the MIB fields:

snmpget -v2c -c Community 10.11.101.101 fgHaStatsCpuUsage
snmpget -v2c -c Community 10.11.101.101 fgHaStatsMemUsage
snmpget -v2c -c Community 10.11.101.101 fgHaStatsNetUsage

Enter the following commands to get CPU, memory and network usage information for the primary unit with
reserved management IP address 10.11.101.101 using the OIDs:

snmpget -v2c -c Community 10.11.101.101 1.3.6.1.4.1.12356.101.13.2.1.1.3.1
snmpget -v2c -c Community 10.11.101.101 1.3.6.1.4.1.12356.101.13.2.1.1.4.1
snmpget -v2c -c Community 10.11.101.101 1.3.6.1.4.1.12356.101.13.2.1.1.5.1
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Enter the following commands to get CPU, memory and network usage information for the subordinate unit with
reserved management IP address 10.11.101.102 using the MIB fields:

snmpget -v2c -c Community 10.11.101.102 fgHaStatsCpuUsage
snmpget -v2c -c Community 10.11.101.102 fgHaStatsMemUsage
snmpget -v2c -c Community 10.11.101.102 fgHaStatsNetUsage

Enter the following commands to get CPU, memory and network usage information for the subordinate unit with
reserved management IP address 10.11.101.102 using the OIDs:

snmpget -v2c -c Community 10.11.101.102 1.3.6.1.4.1.12356.101.13.2.1.1.3.1
snmpget -v2c -c Community 10.11.101.102 1.3.6.1.4.1.12356.101.13.2.1.1.4.1
snmpget -v2c -c Community 10.11.101.102 1.3.6.1.4.1.12356.101.13.2.1.1.5.1

Adding firewall local-in policies for the dedicated HA management interface

To add local-in polices for the dedicated management interface, enable ha-mgmt-inft-only and set intf to
any. Enabling ha-mgmt-intf-only means the local-in policy applies only to the VDOM that contains the
dedicated HAmanagement interface. For example:

config firewall local-in-policy
edit 0

set ha-mgmt-intf-only enable
set intf any
set scraddr internal-net
set dstaddr mgmt-int
set action accept
set service HTTPS
set schedule weekdays

end

NTP over Dedicated HA management interfaces

If you set up dedicated management interfaces on each cluster unit, if NTP is enabled, the primary unit contacts
an NTP server using the dedicated management interface. System time is then synchronized to the backup units
through the HA heartbeat.

Example CLI:

config system interface
edit port5

set ip 172.16.79.46 255.255.255.0
end

config system ha
set group-name FGT-HA
set mode a-p
set ha-mgmt-status enable

config ha-mgmt-interfaces
edit 1

set interface port5
set gateway 172.16.79.1

end
set ha-direct enable

end

config system ntp
set ntpsync enable
set syncinterval 5
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end

Managing individual cluster units using an in-band management IP address
You can use the following command to add an in-band management IP address to an individual cluster unit
interface that is also connected to a network and processing traffic. The in-band management IP address is an
alternative to the reserved HAmanagement interface feature and does not require reserving an interface just for
management access.

config system interface
edit port1

set management-ip 172.20.121.155/24
end

The management IP address is accessible from the network that the cluster interface is connected to. This
setting is not synchronized so each cluster unit can have their own in-band management IP addresses. You can
add a management IP address to one or more interfaces of each cluster unit.

The in-band management IP address should be on the same subnet as the interface you are adding it to, but
cannot be on the same subnet as other interface IP addresses.

You can connect to the in-band management IP address using the interface's administrative access settings. The
in-band management IP only supports the following subset of administrative access settings: ping, Telnet, HTTP,
HTTPS, and SNMP.

For example, use the following command to add an in-band management IP address and allow access using
HTTPS, SSH and SNMP:

config system interface
edit port23

set management-ip 172.25.12.5/24
set allowaccess https ssh snmp

end

Managing individual cluster units in a virtual cluster
You can select the HA option Do NOT Synchronize Management VDOM Configuration if you have enabled
multiple VDOMS and set a VDOM other than the root VDOM to be the management VDOM. You can select this
option to prevent the management VDOM configuration from being synchronized between cluster units in a
virtual cluster. This allows you to add an interface to the VDOM in each cluster unit and then to give the interfaces
different IP addresses in each cluster unit, allowing you to manage each cluster unit separately.

You can also enable this feature using the following command:

config system ha
set standalone-mgmt-vdom enable

end

This feature must be disabled to manage a cluster using FortiManager.
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Shutting down or rebooting the primary unit
You can shutdown or reboot the primary unit from the primary unit GUI by selecting Shutdown orReboot from
the Adminmenu. From the primary unit CLI you can use the execute reboot or execute shutdown
commands to shutdown or reboot the primary unit.

During the shutdown the primary unit first becomes the backup unit before shutting down allowing the backup unit
to become the new primary unit and avoiding a split brain scenario. This behavior only happens when you
manually shutdown or reboot the primary unit.

The primary unit acts as a router for subordinate unit management traffic
HA uses routing and inter-VDOM links to route subordinate unit management traffic through the primary unit to
the network. Similar to a standalone FortiGate, subordinate units may generate their own management traffic,
including:

l DNS queries.
l FortiGuard Web Filtering rating requests.
l Log messages to be sent to a FortiAnalyzer unit, to a syslog server, or to the FortiGuard Analysis and Management

Service.
l Log file uploads to a FortiAnalyzer unit.
l Quarantine file uploads to a FortiAnalyzer unit.
l SNMP traps.
l Communication with remote authentication servers (RADIUS, LDAP, TACACS+ and so on)

Subordinate units send this management traffic over the HA heartbeat link to the primary unit. The primary unit
forwards the management traffic to its destination. The primary unit also routes replies back to the subordinate
unit in the same way.

HA uses a hidden VDOM called vsys_ha for HA operations. The vsys_ha VDOM includes the HA heartbeat
interfaces, and all communication over the HA heartbeat link goes through the vsys_ha VDOM. To provide
communication from a subordinate unit to the network, HA adds hidden inter-VDOM links between the primary
unit management VDOM and the primary unit vsys_ha VDOM. By default, root is the management VDOM.

Management traffic from the subordinate unit originates in the subordinate unit vsys_ha VDOM. The vsys_ha
VDOM routes the management traffic over the HA heartbeat link to the primary unit vsys_ha VDOM. This
management traffic is then routed to the primary unit management VDOM and from there out onto the network.

DNS queries and FortiGuard Web Filtering and Email Filter requests are still handled by the HA proxy so the
primary unit and subordinate units share the same DNS query cache and the same FortiGuard Web Filtering and
Email Filter cache. In a virtual clustering configuration, the cluster unit that is the primary unit for the
management virtual domain maintains the FortiGuard Web Filtering, Email Filtering, and DNS query cache.
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Subordinate unit management traffic path

Cluster communication with RADIUS and LDAP servers
In an active-passive cluster, only the primary unit processes traffic, so the primary unit communicates with
RADIUS or LDAP servers. In a cluster that is operating in active-active mode, subordinate units send RADIUS and
LDAP requests to the primary unit over the HA heartbeat link and the primary units routes them to their
destination. The primary unit relays the responses back to the subordinate unit.

Clusters and FortiGuard services
This section describes how various FortiGate HA clustering configurations communicate with the FDN.

In an operating cluster, the primary unit communicates directly with the FortiGuard Distribution Network (FDN).
Subordinate units also communicate directly with the FDN but as described above, all communication between
subordinate units and the FDN is routed through the primary unit.

You must register and license all of the units in a cluster for all required FortiGuard services, both because all
cluster units communicate with the FDN and because any cluster unit could potentially become the primary unit.

FortiGuard and active-passive clusters

For an active-passive cluster, only the primary unit processes traffic. Even so, all cluster units communicate with
the FDN. Only the primary unit sends FortiGuard Web Filtering and Antispam requests to the FDN. All cluster
units receive FortiGuard Antivirus, IPS, and application control updates from the FDN.

In an active-passive cluster the FortiGuard Web Filter and Email Filter caches are located on the primary unit in
the same way as for a standalone FortiGate. The caches are not shared among cluster units so after a failover
the new primary unit must build up new caches.

In an active-passive cluster all cluster units also communicate with the FortiGuard Analysis and Management
Service (FAMS).

FortiGuard and active-active clusters

For an active-active cluster, both the primary unit and the subordinate units process traffic. Communication
between the cluster units and the FDN is the same as for active-passive clusters with the following exception.

Because the subordinate units process traffic, they may also be making FortiGuard Web Filtering and Email Filter
requests. The primary unit receives all such requests from the subordinate units and relays them to the FDN and
then relays the FDN responses back to the subordinate units. The FortiGuard Web Filtering and Email Filtering
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URL caches are maintained on the primary unit. The primary unit caches are used for primary and subordinate
unit requests.

FortiGuard and virtual clustering

For a virtual clustering configuration the management virtual domain of each cluster unit communicates with the
FDN. The cluster unit that is the primary unit for the management virtual domain maintains the FortiGuard Web
Filtering and Email Filtering caches. All FortiGuard Web Filtering and Email Filtering requests are proxied by the
management VDOM of the cluster unit that is the primary unit for the management virtual domain.

Clusters and logging
This section describes the log messages that provide information about how HA is functioning, how to view and
manage logs for each unit in a cluster, and provides some example log messages that are recorded during
specific cluster events.

You configure logging for a cluster in the same way as you configuring logging for a standalone FortiGate. Log
configuration changes made to the cluster are synchronized to all cluster units.

All cluster units record log messages separately to the individual cluster unit’s log disk, to the cluster unit’s system
memory, or both. You can view and manage log messages for each cluster unit from the cluster GUI Log Access
page.

When remote logging is configured, all cluster units send log messages to remote FortiAnalyzer units or other
remote servers as configured. HA uses routing and inter-VDOM links to route subordinate unit log traffic through
the primary unit to the network.

When you configure a FortiAnalyzer unit to receive log messages from a FortiGate cluster, you should add a
cluster to the FortiAnalyzer unit configuration so that the FortiAnalyzer unit can receive log messages from all
cluster units.

Viewing and managing log messages for individual cluster units

This section describes how to view and manage log messages for an individual cluster unit.

To view HA cluster log messages

1. Log into the cluster GUI.
2. Go to Log&Report > Log Config > Log Settings > GUI Preferences and select to display logs from

Memory, Disk or FortiAnalyzer.
For each log display, the HA Cluster list displays the serial number of the cluster unit for which log
messages are displayed. The serial numbers are displayed in order in the list.

3. Set HA Cluster to the serial number of one of the cluster units to display log messages for that unit.

About HA event log messages

HA event log messages always include the host name and serial number of the cluster unit that recorded the
message. HA event log messages also include the HA state of the unit and also indicate when a cluster unit
switches (or moves) from one HA state to another. Cluster units can operate in the HA states listed below:
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HA states

Hello A FortiGate configured for HA operation has started up and is looking for other
FortiGates with which to form a cluster.

Work In an active-passive cluster a cluster unit is operating as the primary unit. In an active-
active cluster unit is operating as the primary unit or a subordinate unit.

Standby In an active-passive cluster the cluster unit is operating as a subordinate unit.

HA log Event log messages also indicate the virtual cluster that the cluster unit is operating in as well as the
member number of the unit in the cluster. If virtual domains are not enabled, all clusters unit are always operating
in virtual cluster 1. If virtual domains are enabled, a cluster unit may be operating in virtual cluster 1 or virtual
cluster 2. The member number indicates the position of the cluster unit in the cluster members list. Member 0 is
the primary unit. Member 1 is the first subordinate unit, member 2 is the second subordinate unit, and so on.

HA log messages

See the FortiOS log message reference for a listing of and descriptions of the HA log messages.

FortiGate HA message "HA master heartbeat interface <intf_name> lost neighbor
information"

The following HA log messages may be recorded by an operating cluster:

2009-02-16 11:06:34 device_id=FG2001111111 log_id=0105035001 type=event subtype=ha
pri=critical vd=root msg="HA slave heartbeat interface internal lost neighbor information"

2009-02-16 11:06:40 device_id=FG2001111111 log_id=0105035001 type=event subtype=ha
pri=notice vd=root msg="Virtual cluster 1 of group 0 detected new joined HAmember"

2009-02-16 11:06:40 device_id=FG2001111111 log_id=0105035001 type=event subtype=ha
pri=notice vd=root msg="HAmaster heartbeat interface internal get peer information"

These log messages indicate that the cluster units could not connect to each other over the HA heartbeat link for
the period of time that is given by hb-interval x hb-lost-threshold, which is 1.2 seconds with the default values.

To diagnose this problem

1. Check all heartbeat interface connections including cables and switches to make sure they are connected and
operating normally.

2. Use the following commands to display the status of the heartbeat interfaces.
get hardware nic <heartbeat_interface_name>
diagnose hardware deviceinfo nic <heartbeat_interface_name>

The status information may indicate the interface status and link status and also indicate if a large
number of errors have been detected.

3. If the log message only appears during peak traffic times, increase the tolerance for missed HA heartbeat packets
by using the following commands to increase the lost heartbeat threshold and heartbeat interval:

config system ha
set hb-lost-threshold 12
set hb-interval 4

end
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These settings multiply by 4 the loss detection interval. You can use higher values as well.

This condition can also occur if the cluster units are located in different buildings or even different
geographical locations. Called a distributed cluster, as a result of the separation it may take a
relatively long time for heartbeat packets to be transmitted between cluster units. You can support a
distributed cluster by increasing the heartbeat interval so that the cluster expects extra time between
heartbeat packets.

4. Optionally disable session-pickup to reduce the processing load on the heartbeat interfaces.
5. Instead of disabling session-pickup you can enable session-pickup-delay to reduce the number of sessions

that are synchronized. With this option enabled only sessions that are active for more than 30 seconds are
synchronized.

It may be useful to monitor CPU and memory usage to check for low memory and high CPU usage. You can
configure event logging to monitor CPU and memory usage. You can also enable the CPU over usage and
memory low SNMP events.

Once this monitoring is in place, try and determine if there have been any changes in the network or an increase
of traffic recently that could be the cause. Check to see if the problem happens frequently and if so what the
pattern is.

To monitor the CPU of the cluster units and troubleshoot further, use the following procedure and commands:

get system performance status
get system performance top 2
diagnose sys top 2

These commands repeated at frequent intervals will show the activity of the CPU and the number of sessions.

Search the Fortinet Knowledge Base for articles about monitoring CPU and Memory usage.

If the problem persists, gather the following information (a console connection might be necessary if connectivity
is lost) and provide it to Technical Support when opening a ticket:

l Debug log from the GUI: System > Advanced > Download Debug Log
l CLI command output:

diagnose sys top 2 (keep it running for 20 seconds)
get system performance status (repeat this command multiple times to get good samples)
get system ha status
diagnose sys ha status
diagnose sys ha dump-by {all options}
diagnose netlink device list
diagnose hardware deviceinfo nic <heartbeat-interface-name>
execute log filter category 1
execute log display

Formatting cluster unit hard disks (log disks)

If you need to format the hard disk (also called log disk or disk storage) of one or more cluster units you should
disconnect the unit from the cluster and use the execute formatlogdisk command to format the cluster
unit hard disk then add the unit back to the cluster.

For information about how to remove a unit from a cluster and add it back, see Disconnecting a cluster unit from a
cluster on page 1905 and Adding a disconnected FortiGate back to its cluster on page 1906 .

Once you add the cluster unit with the formatted log disk back to the cluster you should make it the primary unit
before removing other units from the cluster to format their log disks and then add them back to the cluster.
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Clusters and SNMP
You can use SNMP to manage a cluster by configuring a cluster interface for SNMP administrative access. Using
an SNMPmanager you can get cluster configuration and status information and receive traps.

You configure SNMP for a cluster in the same way as configuring SNMP for a standalone FortiGate. SNMP
configuration changes made to the cluster are shared by all cluster units.

Each cluster unit sends its own traps and SNMPmanager systems can use SNMP get commands to query each
cluster unit separately. To set SNMP get queries to each cluster unit you must create a special get command that
includes the serial number of the cluster unit.

Alternatively you can use the HA reserved management interface feature to give each cluster unit a different
management IP address. Then you can create an SNMP get command for each cluster unit that just includes the
management IP address and does not have to include the serial number.

SNMP get command syntax for the primary unit

Normally, to get configuration and status information for a standalone FortiGate or for a primary unit, an SNMP
manager would use an SNMP get commands to get the information in a MIB field. The SNMP get command
syntax would be similar to the following:

snmpget -v2c -c <community_name> <address_ipv4> {<OID> | <MIB_field>}

where:

<community_name> is an SNMP community name added to the FortiGate configuration. You can add more
than one community name to a FortiGate SNMP configuration. The most commonly used community name is
public.

<address_ipv4> is the IP address of the FortiGate interface that the SNMPmanager connects to.

{<OID> | <MIB_field>} is the object identifier (OID) for the MIB field or the MIB field name itself. The HA
MIB fields and OIDs are listed below:

SNMP field names and OIDs

MIB field OID Description

fgHaSystemMode .1.3.6.1.4.1.12356.101.13.1.1.0 HAmode (standalone, a-a, or a-p)

fgHaGroupId .1.3.6.1.4.1.12356.101.13.1.2.0 The HA group ID of the cluster unit.

fgHaPriority .1.3.6.1.4.1.12356.101.13.1.3.0 The HA priority of the cluster unit. Default
128.

fgHaOverride .1.3.6.1.4.1.12356.101.13.1.4.0 Whether HA override is disabled or enabled
for the cluster unit.

fgHaAutoSync .1.3.6.1.4.1.12356.101.13.1.5.0 Whether automatic HA synchronization is
disabled or enabled.
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MIB field OID Description

fgHaSchedule .1.3.6.1.4.1.12356.101.13.1.6.0 The HA load balancing schedule. Set to
none unless operating in a-p mode.

fgHaGroupName .1.3.6.1.4.1.12356.101.13.1.7.0 The HA group name.

fgHaStatsIndex .1.3.6.1.4.1.12356.101.13.2.1.1.1.1

An index value that identifies the
FortiGates in an HA cluster. The index is
always 1 for the FortiGate that receives the
HA get. The other FortiGate(s) in the
cluster will have an index of 2, 3, or 4. For
example, if you get the stats index from the
primary FortiGate, the primary FortiGate
will have a stats index of 1 and the backup
FortiGate will have a stats index of 2. If you
get the stats index from the backup unit,
the backup unit will have a stats index of 1
and the primary unit will have a stats index
of 2.

fgHaStatsSerial .1.3.6.1.4.1.12356.101.13.2.1.1.2.1 The serial number of the cluster unit.

fgHaStatsCpuUsage .1.3.6.1.4.1.12356.101.13.2.1.1.3.1 The cluster unit’s current CPU usage.

fgHaStatsMemUsage .1.3.6.1.4.1.12356.101.13.2.1.1.4.1 The cluster unit’s current Memory usage.

fgHaStatsNetUsage .1.3.6.1.4.1.12356.101.13.2.1.1.5.1 The cluster unit’s current Network
bandwidth usage.

fgHaStatsSesCount .1.3.6.1.4.1.12356.101.13.2.1.1.6.1 The cluster unit’s current session count.

fgHaStatsPktCount .1.3.6.1.4.1.12356.101.13.2.1.1.7.1 The cluster unit’s current packet count.

fgHaStatsByteCount .1.3.6.1.4.1.12356.101.13.2.1.1.8.1 The cluster unit’s current byte count.

fgHaStatsIdsCount .1.3.6.1.4.1.12356.101.13.2.1.1.9.1 The number of attacks reported by the IPS
for the cluster unit.

fgHaStatsAvCount .1.3.6.1.4.1.12356.101.13.2.1.1.10.1 The number of viruses reported by the
antivirus system for the cluster unit.

fgHaStatsHostname .1.3.6.1.4.1.12356.101.13.2.1.1.11.1 The hostname of the cluster unit.

To get the HA priority for the primary unit

The following SNMP get command gets the HA priority for the primary unit. The community name is public.
The IP address of the cluster interface configured for SNMPmanagement access is 10.10.10.1. The HA priority
MIB field is fgHaPriority and the OID for this MIB field is 1.3.6.1.4.1.12356.101.13.1.3.0 The first command uses
the MIB field name and the second uses the OID:

snmpget -v2c -c public 10.10.10.1 fgHaPriority
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snmpget -v2c -c public 10.10.10.1 1.3.6.1.4.1.12356.101.13.1.3.0

SNMP get command syntax for any cluster unit

To get configuration status information for a specific cluster unit (for the primary unit or for any subordinate unit),
the SNMPmanager must add the serial number of the cluster unit to the SNMP get command after the
community name. The community name and the serial number are separated with a dash. The syntax for this
SNMP get command would be:

snmpget -v2c -c <community_name>-<fgt_serial> <address_ipv4> {<OID> | <MIB_field>}

where:

<community_name> is an SNMP community name added to the FortiGate configuration. You can add more
than one community name to a FortiGate SNMP configuration. All units in the cluster have the same community
name. The most commonly used community name is public.

<fgt_serial> is the serial number of any cluster unit. For example, FGT4002803033172. You can specify the
serial number of any cluster unit, including the primary unit, to get information for that unit.

<address_ipv4> is the IP address of the FortiGate interface that the SNMPmanager connects to.

{<OID> | <MIB_field>} is the object identifier (OID) for the MIB field or the MIB field name itself.

If the serial number matches the serial number of a subordinate unit, the SNMP get request is sent over the HA
heartbeat link to the subordinate unit. After processing the request, the subordinate unit sends the reply back over
the HA heartbeat link back to the primary unit. The primary unit then forwards the response back to the SNMP
manager.

If the serial number matches the serial number of the primary unit, the SNMP get request is processed by the
primary unit. You can actually add a serial number to the community name of any SNMP get request. But
normally you only need to do this for getting information from a subordinate unit.

To get the CPU usage for a subordinate unit

The following SNMP get command gets the CPU usage for a subordinate unit in a FortiGate-5001SX cluster. The
subordinate unit has serial number FG50012205400050. The community name is public. The IP address of
the FortiGate interface is 10.10.10.1. The HA status table MIB field is fgHaStatsCpuUsage and the OID for this
MIB field is 1.3.6.1.4.1.12356.101.13.2.1.1.3.1. The first command uses the MIB field name and the second
uses the OID for this table:

snmpget -v2c -c public-FG50012205400050 10.10.10.1 fgHaStatsCpuUsage
snmpget -v2c -c public-FG50012205400050 10.10.10.1 1.3.6.1.4.1.12356.101.13.2.1.1.3.1

FortiGate SNMP recognizes the community name with syntax <community_name>-<fgt_serial>. When
the primary unit receives an SNMP get request that includes the community name followed by serial number, the
FGCP extracts the serial number from the request. Then the primary unit redirects the SNMP get request to the
cluster unit with that serial number. If the serial number matches the serial number of the primary unit, the SNMP
get is processed by the primary unit.

Getting serial numbers of cluster units

The following SNMP get commands use the MIB field name fgHaStatsSerial.<index> to get the serial number of
each cluster unit. Where <index> is the cluster unit’s cluster index and 1 is the cluster index of the primary unit, 2
is the cluster index of the first subordinate unit, and 3 is the cluster index of the second subordinate unit.

The OID for this MIB field is 1.3.6.1.4.1.12356.101.13.2.1.1.2.1. The community name is public.
The IP address of the FortiGate interface is 10.10.10.1.
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The first command uses the MIB field name and the second uses the OID for this table and gets the serial
number of the primary unit:

snmpget -v2c -c public 10.10.10.1 fgHaStatsSerial.1
snmpget -v2c -c public 10.10.10.1 1.3.6.1.4.1.12356.101.13.2.1.1.2.1

The second command uses the MIB field name and the second uses the OID for this table and gets the serial
number of the first subordinate unit:

snmpget -v2c -c public 10.10.10.1 fgHaStatsSerial.2
snmpget -v2c -c public 10.10.10.1 1.3.6.1.4.1.12356.101.13.2.2.2

SNMP get command syntax - reserved management interface enabled

To get configuration and status information for any cluster unit where you have enabled the HA reserved
management interface feature and assigned IP addresses to the management interface of each cluster unit, an
SNMPmanager would use the following get command syntax:

snmpget -v2c -c <community_name> <mgmt_address_ipv4> {<OID> | <MIB_field>}

where:

<community_name> is an SNMP community name added to the FortiGate configuration. You can add more
than one community names to a FortiGate SNMP configuration. The most commonly used community name is
public.

<mgmt_address_ipv4> is the IP address of the FortiGate HA reserved management interface that the SNMP
manager connects to.

{<OID> | <MIB_field>} is the object identifier (OID) for the MIB field or the MIB field name itself. To find
OIDs and MIB field names see your FortiGate’s online help.

Adding FortiClient licenses to a cluster
Each FortiGate in a cluster must have its own FortiClient license. Contact your reseller to purchase FortiClient
licenses for all of the FortiGates in your cluster.

When you receive the license keys you can visit the Fortinet Support website and add the FortiClient license keys
to each FortiGate. Then, as long as the cluster can connect to the Internet each cluster unit receives its
FortiClient license key from the FortiGuard network.

Adding FortiClient licenses to cluster units with a reserved management interface

You can also use the following steps to manually add license keys to your cluster units from the GUI or CLI. Your
cluster must be connected to the Internet and you must have configured a reserved management interface for
each cluster unit.

1. Log into the GUI of each cluster unit using its reserved management interface IP address.
2. Go to the License Information dashboard widget and beside FortiClient select Enter License.
3. Enter the license key and select OK.
4. Confirm that the license has been installed and the correct number of FortiClients are licensed.
5. Repeat for all of the cluster units.
You can also use the reserved management IP address to log into each cluster unit CLI and use following
command to add the license key:

execute FortiClient-NAC update-registration-license <license-key>

You can connect to the CLIs of each cluster unit using their reserved management IP address.
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Adding FortiClient licenses to cluster units with no reserved management interface

If you have not set up reserved management IP addresses for your cluster units, you can still add FortiClient
license keys to each cluster unit. You must log into the primary unit and then use the execute ha manage
command to connect to each cluster unit CLI. For example, use the following steps to add a FortiClient license
key a cluster of three FortiGates:

1. Log into the primary unit CLI and enter the following command to confirm the serial number of the primary unit:
get system status

2. Add the FortiClient license key for that serial number to the primary unit:
execute FortiClient-NAC update-registration-license <license-key>

You can also use the GUI to add the license key to the primary unit.

3. Enter the following command to log into the first subordinate unit:
execute ha manage 1

4. Enter the following command to confirm the serial number of the cluster unit that you have logged into:
get system status

5. Add the FortiClient license key for that serial number to the cluster unit:
execute FortiClient-NAC update-registration-license <license-key>

6. Enter the following command to log into the second subordinate unit:
execute ha manage 2

7. Enter the following command to confirm the serial number of the cluster unit that you have logged into:
get system status

8. Add the FortiClient license key for that serial number to the cluster unit:
execute FortiClient-NAC update-registration-license <license-key>

Viewing FortiClient license status and active FortiClient users for each cluster unit

To view FortiClient license status and FortiClient information for each cluster unit you must log into each cluster
unit’s GUI or CLI. You can do this by connecting to each cluster unit’s reserved management interface if they are
configured. If you have not configured reserved management interfaces you can use the execute ha manage
command to log into each cluster unit CLI.

From the GUI, view FortiClient License status from the License Information dashboard widget and select Details
to display the list of active FortiClient users connecting through that cluster unit. You can also see active
FortiClient users by going to User & Device > Monitor > FortiClient.

From the CLI you can use the execute FortiClient {list | info} command to display FortiClient
license status and active FortiClient users.

For example, use the following command to display the FortiClient license status of the cluster unit that you are
logged into:

execute forticlient info
Maximum FortiClient connections: unlimited.
Licensed connections: 114

NAC: 114
WANOPT: 0
Test: 0
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Other connections:
IPsec: 0
SSLVPN: 0

Use the following command to display the list of active FortiClient users connecting through the cluster unit. The
output shows the time the connection was established, the type of FortiClient connection, the name of the
device, the user name of the person connecting, the FortiClient ID, the host operating system, and the source IP
address of the session.

execute forticlient list
TIMESTAMP TYPE CONNECT-NAME USER CLIENT-ID HOST-OS SRC-IP

20141017 09:13:33 NAC Gordon-PC Gordon 11F76E902611484A942E31439E428C5C Microsoft
Windows 7 , 64-bit Service Pack 1 (build 7601) 172.20.120.10

20141017 09:11:55 NAC Gordon-PC 11F76E902611484A942E31439E428C5C Microsoft Windows 7 ,
64-bit Service Pack 1 (build 7601) 172.20.120.10

20141017 07:27:11 NAC Desktop11 Richie 9451C0B8EE3740AEB7019E920BB3761B Microsoft
Windows 7, 64-bit Service Pack 1 (build 7601) 172.20.120.20

Cluster members list
To display the cluster members list, log into an operating cluster and go to System > HA.

The cluster members list displays illustrations of the front panels of the cluster units. The displays use color
coding to indicate the status and configuration of individual cluster unit interfaces:

l Green indicates data interfaces that are up and connected to data networks
l Yellow indicates monitored data interfaces that are up and connected to data networks
l Red indicates connected heartbeat interfaces
l Grey indicates unconnected data interfaces
l A pale salmon color indicates disconnected monitored interfaces or heartbeat interfaces

You can hover the mouse pointer over each interface to view the interface IP address (if any) link status, and
speed.

From the cluster members list you can:

l View HA statistics including uptime, sessions, and throughput for each cluster unit.
l Click and drag to change the order of the cluster units.
l See the host name of each cluster unit. To change the primary unit host name, go to System > Settings and

change the Host Name. To view and change a subordinate unit host name, edit the subordinate unit from the
cluster members list.

l View the status or role of each cluster unit (master or slave).
l View and optionally change the HA configuration of the operating cluster.
l Disconnect a device from the cluster.

Virtual cluster members list
If virtual domains are enabled, you can display the cluster members list to view the status of the operating virtual
clusters. The virtual cluster members list shows the status of both virtual clusters including the virtual domains
added to each virtual cluster.

To display the virtual cluster members list for an operating cluster log in as the admin administrator, select Global
Configuration and go to System > HA.
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The functions of the virtual cluster members list are the same as the functions of the Cluster Members list with
the following exceptions.

l When you edit a primary unit in a virtual cluster, you can change the virtual cluster 1 and virtual cluster 2 device
priority of this cluster unit and you can edit the VDOM partitioning configuration of the cluster.

l When you edit a subordinate unit in a virtual cluster, you can change the device priority for the subordinate unit for
the selected virtual cluster.

Also, the HA cluster members list changes depending on the cluster unit that you connect to.

Viewing HA statistics
From the cluster members list you can select View HA statistics to display the serial number, status, and
monitor information for each cluster unit. To view HA statistics, go to System > HA and select View HA
Statistics. Note the following about the HA statistics display:

l Use the serial number ID to identify each FortiGate in the cluster. The cluster ID matches the FortiGate serial
number.

l Status indicates the status of each cluster unit. A green check mark indicates that the cluster unit is operating
normally. A red X indicates that the cluster unit cannot communicate with the primary unit.

l The up time is the time in days, hours, minutes, and seconds since the cluster unit was last started.
l The GUI displays CPU usage for core processes only. CPU usage for management processes (for example, for

HTTPS connections to the GUI) is excluded.
l The GUI displays memory usage for core processes only. Memory usage for management processes (for example,

for HTTPS connections to the GUI) is excluded.

Changing the HA configuration of an operating cluster
To change the configuration settings of an operating cluster, go to System > HA to display the cluster members
list. Select Edit for the master (or primary) unit in the cluster members list to display the HA configuration page for
the cluster.

You can use the HA configuration page to check and fine tune the configuration of the cluster after the cluster is
up and running. For example, if you connect or disconnect cluster interfaces you may want to change the Port
Monitor configuration.

Any changes you make on this page, with the exception of changes to the device priority, are first made to the
primary unit configuration and then synchronized to the subordinate units. Changing the device priority only
affects the primary unit.

Changing the HA configuration of an operating virtual cluster
To change the configuration settings of the primary unit in a functioning cluster with virtual domains enabled, log
in as the admin administrator, select Global Configuration and go to System > HA to display the cluster
members list. Select Edit for the master (or primary) unit in virtual cluster 1 or virtual cluster 2 to display the HA
configuration page for the virtual cluster.

You can use the virtual cluster HA configuration page to check and fine tune the configuration of both virtual
clusters after the cluster is up and running. For example, you may want to change the Port Monitor configuration
for virtual cluster 1 and virtual cluster 2 so that each virtual cluster monitors its own interfaces.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1893



Operating clusters and virtual clusters Chapter 15 - High Availability

You can also use this configuration page to move virtual domains between virtual cluster 1 and virtual cluster 2.
Usually you would distribute virtual domains between the two virtual clusters to balance the amount of traffic
being processed by each virtual cluster.

Any changes you make on this page, with the exception of changes to the device priorities, are first made to the
primary unit configuration and then synchronized to the subordinate unit.

You can also adjust device priorities to configure the role of this cluster unit in the virtual cluster. For example, to
distribute traffic to both cluster units in the virtual cluster configuration, you would want one cluster unit to be the
primary unit for virtual cluster 1 and the other cluster unit to be the primary unit for virtual cluster 2. You can create
this configuration by setting the device priorities. The cluster unit with the highest device priority in virtual cluster 1
becomes the primary unit for virtual cluster 1. The cluster unit with the highest device priority in virtual cluster 2
becomes the primary unit in virtual cluster 2.

Changing the subordinate unit host name and device priority
To change the host name and device priority of a subordinate unit in an operating cluster, go to System > HA to
display the cluster members list. Select Edit for any slave (subordinate) unit in the cluster members list.

To change the host name and device priority of a subordinate unit in an operating cluster with virtual domains
enabled, log in as the admin administrator, select Global Configuration and go to System > HA to display the
cluster members list. Select Edit for any slave (subordinate) unit in the cluster members list.

You can change the host name (Peer) and device priority (Priority) of this subordinate unit. These changes only
affect the configuration of the subordinate unit.

The device priority is not synchronized among cluster members. In a functioning cluster you can change device
priority to change the priority of any unit in the cluster. The next time the cluster negotiates, the cluster unit with
the highest device priority becomes the primary unit.

The device priority range is 0 to 255. The default device priority is 128.

Upgrading cluster firmware
You can upgrade the FortiOS firmware running on an HA cluster in the same manner as upgrading the firmware
running on a standalone FortiGate. During a normal firmware upgrade, the cluster upgrades the primary unit and
all subordinate units to run the new firmware image. The firmware upgrade takes place without interrupting
communication through the cluster.

Upgrading cluster firmware to a new major release (for example upgrading from 5.6.3
to 6.0.2) is supported for clusters. Make sure you are taking an appropriate upgrade
path. Even so you should back up your configuration and only perform such a firmware
upgrade during a maintenance window.

To upgrade the firmware without interrupting communication through the cluster, the cluster goes through a
series of steps that involve first upgrading the firmware running on the subordinate units, then making one of the
subordinate units the primary unit, and finally upgrading the firmware on the former primary unit. These steps are
transparent to the user and the network, but depending upon your HA configuration may result in the cluster
selecting a new primary unit.

The following sequence describes in detail the steps the cluster goes through during a firmware upgrade and how
different HA configuration settings may affect the outcome.
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1. The administrator uploads a new firmware image from the GUI or CLI.
2. If the cluster is operating in active-active mode load balancing is turned off.
3. The cluster upgrades the firmware running on all of the subordinate units.
4. Once the subordinate units have been upgraded, a new primary unit is selected.

This primary unit will be running the new upgraded firmware.

5. The cluster now upgrades the firmware of the former primary unit.
If the age of the new primary unit is more than 300 seconds (5 minutes) greater than the age of all
other cluster units, the new primary unit continues to operate as the primary unit.

This is the intended behavior but does not usually occur because the age difference of the cluster
units is usually less than the cluster age difference margin of 300 seconds. So instead, the cluster
negotiates again to select a primary unit as described in Primary unit selection on page 1744.

You can keep the cluster from negotiating again by reducing the cluster age difference margin using
the ha-uptime-diff-margin option. However, you should be cautious when reducing the age or
other problemsmay occur. For information about the cluster age difference margin, see Cluster age
difference margin (grace period) on page 1747. For more information about changing the cluster age
margin, see Changing the cluster age difference margin on page 1748.

6. If the cluster is operating in active-active mode, load balancing is turned back on.

If, during the firmware upgrade process all of the subordinate units crash or otherwise
stop responding, the primary unit will not be upgraded to the new firmware, but will
continue to operate normally. The primary unit waits until at least one subordinate unit
rejoins the cluster before upgrading its firmware.

Changing how the cluster processes firmware upgrades

By default cluster firmware upgrades proceed as uninterruptable upgrades that do not interrupt traffic flow. If
required, you can use the following CLI command to change how the cluster handles firmware upgrades. You
might want to change this setting if you are finding uninterruptable upgrades take too much time.

config system ha
set uninterruptible-upgrade disable

end

uninterruptible-upgrade is enabled by default. If you disable uninterruptible-upgrade the
cluster still upgrades the firmware on all cluster units, but all cluster units are upgraded at once; which takes less
time but interrupts communication through the cluster.

Synchronizing the firmware build running on a new cluster unit

If the firmware build running on a FortiGate that you add to a cluster is older than the cluster firmware build, you
may be able to use the following steps to synchronize the firmware running on the new cluster unit.

This procedure describes re-installing the same firmware build on a cluster to force the cluster to upgrade all
cluster units to the same firmware build.

Due to firmware upgrade and synchronization issues, in some cases this procedure may not work. In all cases it
will work to install the same firmware build on the new unit as the one that the cluster is running before adding the
new unit to the cluster.
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To synchronize the firmware build running on a new cluster unit

1. Obtain a firmware image that is the same as build already running on the cluster.
2. Connect to the cluster using the GUI.
3. Go to the System Information dashboard widget.
4. Select Update beside Firmware Version.

You can also install a newer firmware build.

5. Select OK.
After the firmware image is uploaded to the cluster, the primary unit upgrades all cluster units to this
firmware build.

Downgrading cluster firmware
For various reasons you may need to downgrade the firmware that a cluster is running. You can use the
information in this section to downgrade the firmware version running on a cluster.

In most cases you can downgrade the firmware on an operating cluster using the same steps as for a firmware
upgrade. A warning message appears during the downgrade but the downgrade usually works and after the
downgrade the cluster continues operating normally with the older firmware image.

Downgrading between some firmware versions, especially if features have changed between the two versions,
may not always work without the requirement to fix configuration issues after the downgrade.

Only perform firmware downgrades during maintenance windows and make sure you back up your cluster
configuration before the downgrade.

If the firmware downgrade that you are planning may not work without configuration loss or other problems, you
can use the following downgrade procedure to make sure your configuration is not lost after the downgrade.

To downgrade cluster firmware

This example shows how to downgrade the cluster shown in Example NAT mode HA network topology. The
cluster consists of two cluster units (FGT_ha_1 and FGT_ha_2). The port1 and port2 interfaces are connected to
networks and the port3 and port4 interfaces are connected together for the HA heartbeat.

This example, describes separating each unit from the cluster and downgrading the firmware for the standalone
FortiGates. There are several ways you could disconnect units from the cluster. This example describes using the
disconnect from cluster function on the cluster members list GUI page.

1. Go to the System Information dashboard widget and backup the cluster configuration.
From the CLI use execute backup config.

2. Go to System > HA and for FGT_ha_1 select the Disconnect from cluster icon.
3. Select the port2 interface and enter an IP address and netmask of 10.11.101.101/24 and select OK.

From the CLI you can enter the following command (FG600B3908600705 is the serial number of the
cluster unit) to be able to manage the standalone FortiGate by connecting to the port2 interface with
IP address and netmask 10.11.101.101/24.

execute ha disconnect FG600B3908600705 port2 10.11.101.101/24

After FGT_ha_1 is disconnected, FGT_ha_2 continues processing traffic.

4. Connect to the FGT_ha_1 GUI or CLI using IP address 10.11.101.101/24 and follow normal procedures to
downgrade standalone FortiGate firmware.
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5. When the downgrade is complete confirm that the configuration of 620_ha_1 is correct.
6. Set the HAmode of FGT_ha_2 to Standalone and follow normal procedures to downgrade standalone FortiGate

firmware.
Network communication will be interrupted for a short time during the downgrade.

7. When the downgrade is complete confirm that the configuration of FGT_ha_2 is correct.
8. Set the HAmode of FGT_ha_2 to Active-Passive or the required HAmode.
9. Set the HAmode of FGT_ha_1 to the same mode as FGT_ha_2.

If you have not otherwise changed the HA settings of the cluster units and if the firmware downgrades
have not affected the configurations the units should negotiate and form cluster running the
downgraded firmware.

Backing up and restoring the cluster configuration
You can backup and restore the configuration of a cluster in the same way as backing up and restoring a
standalone FortiGate unit. Backing up the cluster from the primary unit GUI or CLI saves a single configuration
file for the cluster. If you restore this configuration file, the configuration of all cluster units is restored. The restore
process keeps configuration settings of individual cluster units that are not synchronized unchanged but resets all
other configuration setting to those in the restored configuration file.

When restoring the configuration of a cluster, all cluster units reboot to install the new
configuration. This may result in a brief traffic interruption as all cluster units may
restart at the same time.

Restoring settings that are not synchronized

The FGCP does not synchronize some FortiOS configuration settings. For details about settings that are not
synchronized, see Synchronizing the configuration (and settings that are not synchronized) on page 1735. If you
need to restore the configuration of the cluster including the configuration settings that are not synchronized, you
should first restore the configuration of the primary FortiGate and then restore the configuration of the other
cluster units. Alternatively you could log into each FortiGate in the cluster and manually add the configuration
settings that were not restored.

Monitoring cluster units for failover
If the primary unit in the cluster fails, the units in the cluster renegotiate to select a new primary unit. Failure of
the primary unit results in the following:

l If SNMP is enabled, the new primary unit sends HA trap messages. The messages indicate a cluster status change,
HA heartbeat failure, and HAmember down.

l If event logging is enabled and HA activity event is selected, the new primary unit records log messages that show
that the unit has become the primary unit.

l If alert email is configured to send email for HA activity events, the new primary unit sends an alert email containing
the log message recorded by the event log.

l The cluster contains fewer FortiGates. The failed primary unit no longer appears on the Cluster Members list.
l The host name and serial number of the primary unit changes. You can see these changes when you log into the

GUI or CLI.
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l The cluster info displayed on the dashboard, cluster members list or from the get system ha status
command changes.

If a subordinate unit fails, the cluster continues to function normally. Failure of a subordinate unit results in the
following:

l If event logging is enabled and HA activity event is selected, the primary unit records log messages that show that a
subordinate has been removed from the cluster.

l If alert email is configured to send email for HA activity events, the new primary unit sends an alert email containing
the log message recorded by the event log.

l The cluster contains fewer FortiGates. The failed unit no longer appears on the Cluster Members list.

Viewing cluster status from the CLI
Use the get system ha status command to display information about an HA cluster. The command
displays general HA configuration settings. The command also displays information about how the cluster unit
that you have logged into is operating in the cluster. You can enter the get system ha status command
from the primary or backup units. The output produced by the command is similar for each unit, it shows cluster
data as well as data for the FortiGate that you are logged into.

For a virtual cluster configuration, the get system ha status command displays information about how the
cluster unit that you have logged into is operating in virtual cluster 1 and virtual cluster 2. For example, if you
connect to the cluster unit that is the primary unit for virtual cluster 1 and the subordinate unit for virtual cluster 2,
the output of the get system ha status command shows virtual cluster 1 in the work state and virtual
cluster 2 in the standby state. The get system ha status command also displays additional information
about virtual cluster 1 and virtual cluster 2.

The command includes the following fields.

Field Description

HA Health Status Indicates if all cluster units are operating normally (OK) or if a problem was
detected with the cluster. For example, a message similar to ERROR <serial-
number> is lost @ <date> <time> appears if one the subordinate units
leaves the cluster.

Model The FortiGate model number.

Mode The HAmode of the cluster, for example, HA A-P or HA A-A.

Group The group ID of the cluster.

Debug The debug status of the cluster.

Cluster Uptime The number of days, hours, minutes, and seconds that the cluster has been
operating.

Cluster state
changed time

The date and time at which the FortiGate most recently changed state. For
example, the last time the FortiGate joined the cluster or changed from the
primary unit to a backup unit, and so on.
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Field Description

Master selected
using

Shows how the primary unit was selected the last four times that the cluster
negotiated. For example, when a cluster first forms, this part of the command
output could have one line showing that the primary unit is the cluster unit with
the highest uptime. Up to four lines can be included as the cluster negotiates to
choose a new primary unit on different occasions. Each line includes a time stamp
and the criteria used to select the primary unit.

ses_pickup The status of session pickup: enable or disable.

load_balance The status of the load-balance-all keyword: enable or disable. Active-
active clusters only.

load_balance_udp The stats of the load-balance-udp keyword: enable or disable. Available on
some FortiGate models. Active-active clusters only.

schedule The active-active load balancing schedule. Active-active clusters only.

override The status of the override option for the current cluster unit: enable or disable.

Configuration
Status Shows if the configurations of each of the cluster units are synchronized or not.

System Usage
stats

Shows how busy each cluster unit is by displaying the number of sessions being
processed by the cluster unit, CPU usage, and memory usage.

HBDEV stats
Shows the status of each cluster unit's heartbeat interfaces. Includes whether the
interfaces are up or down, how much data they have processed, as well as errors
found.

Master
Slave

Displays the host name, serial number, and cluster index of the primary unit
(master) and the subordinate units (slave). The FortiGate with cluster index 0 is
the primary unit and the FortiGates with cluster indexes 1 to 3 are the backup
units.

The order in which the cluster units are listed starts with the cluster unit that you
are logged into.

number of
vcluster

The number of virtual clusters. If virtual domains are not enabled, the cluster has
one virtual cluster. If virtual domains are enabled the cluster has two virtual
clusters.

vcluster 1
vcluster 2

The heartbeat interface IP address of the primary unit in each virtual cluster. If
virtual domains are not enabled there is one vcluster and this is the IP address of
the primary unit. If virtual domains are enabled then each vcluster line will have
an IP address. If the IP addresses are the same then the same FortiGate is the
primary unit for both virtual clusters.
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Field Description

vcluster 1
Master
Slave

The HA state (hello, work, or standby) and HA heartbeat IP address of the primary
unit. If virtual domains are not enabled, vcluster 1 displays information for
the cluster. If virtual domains are enabled, vcluster 1 displays information for
virtual cluster 1.

vcluster 1 also lists the primary unit (master) and subordinate units (slave) in
virtual cluster 1. The list includes the serial number and operating cluster index of
each cluster unit in virtual cluster 1. The cluster unit that you have logged into is at
the top of the list. The FortiGate in the cluster with the highest serial number
always has an operating cluster index of 0. Other FortiGates in the cluster get a
higher operating cluster index based in their serial number. When you use the
execute ha manage command to log into another FortiGate you use the
operating cluster index to specify the FortiGate to log into.

If virtual domains are not enabled and you connect to the primary unit CLI, the HA
state of the cluster unit in virtual cluster 1 is work. The display lists the cluster
units starting with the primary unit.

If virtual domains are not enabled and you connect to a subordinate unit CLI, the
HA state of the cluster unit in virtual cluster 1 is standby. The display lists the
cluster units starting with the subordinate unit that you have logged into.

If virtual domains are enabled and you connect to the virtual cluster 1 primary unit
CLI, the HA state of the cluster unit in virtual cluster 1 is work. The display lists the
cluster units starting with the virtual cluster 1 primary unit.

If virtual domains are enabled and you connect to the virtual cluster 1 subordinate
unit CLI, the HA state of the cluster unit in virtual cluster 1 is standby. The display
lists the cluster units starting with the subordinate unit that you are logged into.

vcluster 2
Master Slave

vcluster 2 only appears if virtual domains are enabled. vcluster 2
displays the HA state (hello, work, or standby) and HA heartbeat IP address of the
cluster unit that you have logged into in virtual cluster 2. The HA heartbeat IP
address is 169.254.0.2 if you are logged into the primary unit of virtual cluster 2
and 169.254.0.1 if you are logged into a subordinate unit of virtual cluster 2.

vcluster 2 also lists the primary unit (master) and subordinate units (slave) in
virtual cluster 2. The list includes the cluster index and serial number of each
cluster unit in virtual cluster 2. The cluster unit that you have logged into is at the
top of the list.

If you connect to the virtual cluster 2 primary unit CLI, the HA state of the cluster
unit in virtual cluster 2 is work. The display lists the cluster units starting with the
virtual cluster 2 primary unit.

If you connect to the virtual cluster 2 subordinate unit CLI, the HA state of the
cluster unit in virtual cluster 2 is standby. The display lists the cluster units
starting with the subordinate unit that you are logged into.
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Get system ha status example - two FortiGates in active-passive mode

The following example shows get system ha status output for a cluster of two FortiGate-600Ds operating
in active-passive mode. The cluster is healthy and has been running for 3 hours and 26 minutes. Primary unit
selection took place once and the cluster has been stable since then.

The following command output was produced by connecting to the primary unit CLI (host name Edge2-
Primary).

get system ha status
HA Health Status: OK
Model: FortiGate-600D
Mode: HA A-P
Group: 25
Debug: 0
Cluster Uptime: 0 days 03:26:00
Cluster state change time: 2018-03-06 13:16:33
Master selected using:

<2018/03/06 13:16:33> FGT6HD3916806098 is selected as the master because it has the
largest value of override priority.

<2018/03/06 12:47:58> FGT6HD3916806070 is selected as the master because it has the
largest value of override priority.

<2018/03/06 12:47:55> FGT6HD3916806098 is selected as the master because it has the
largest value of uptime.

<2018/03/06 12:47:55> FGT6HD3916806098 is selected as the master because it's the only
member in the cluster.
ses_pickup: enable, ses_pickup_delay=disable
override: disable
Configuration Status:

FGT6HD3916806098(updated 1 seconds ago): in-sync
FGT6HD3916806070(updated 2 seconds ago): in-sync

System Usage stats:
FGT6HD3916806098(updated 1 seconds ago):

sessions=141, average-cpu-user/nice/system/idle=0%/0%/0%/100%, memory=34%
FGT6HD3916806070(updated 2 seconds ago):

sessions=12, average-cpu-user/nice/system/idle=0%/0%/0%/100%, memory=33%
HBDEV stats:

FGT6HD3916806098(updated 1 seconds ago):
port3: physical/1000full, up, rx-bytes/packets/dropped/errors=45437370/71531/0/0,

tx=36186194/65035/0/0
port4: physical/1000full, up, rx-bytes/packets/dropped/errors=27843923/39221/0/0,

tx=27510707/39075/0/0
FGT6HD3916806070(updated 2 seconds ago):

port3: physical/1000full, up, rx-bytes/packets/dropped/errors=37267057/67136/0/0,
tx=46354380/73516/0/0

port4: physical/1000full, up, rx-bytes/packets/dropped/errors=28294029/40177/0/0,
tx=28536766/40208/0/0
Master: Edge2-Primary , FGT6HD3916806098, cluster index = 0
Slave : Edge2-Backup , FGT6HD3916806070, cluster index = 1
number of vcluster: 1
vcluster 1: work 169.254.0.1
Master: FGT6HD3916806098, operating cluster index = 0
Slave : FGT6HD3916806070, operating cluster index = 1

The following command output was produced by using execute ha manage 1 to log into the subordinate
unit CLI of the cluster shown in the previous example. The host name of the subordinate unit is Edge2-
Backup.
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get system ha status
HA Health Status: OK
Model: FortiGate-600D
Mode: HA A-P
Group: 25
Debug: 0
Cluster Uptime: 0 days 03:33:04
Cluster state change time: 2018-03-06 13:16:33
Master selected using:

<2018/03/06 13:16:33> FGT6HD3916806098 is selected as the master because it
has the largest value of override priority.

<2018/03/06 12:47:58> FGT6HD3916806070 is selected as the master because it
has the largest value of override priority.

<2018/03/06 12:47:57> FGT6HD3916806098 is selected as the master because it
has the largest value of uptime.

<2018/03/06 12:47:56> FGT6HD3916806098 is selected as the master because it
has the largest value of uptime.
ses_pickup: enable, ses_pickup_delay=disable
override: disable
Configuration Status:

FGT6HD3916806070(updated 1 seconds ago): in-sync
FGT6HD3916806098(updated 1 seconds ago): in-sync

System Usage stats:
FGT6HD3916806070(updated 1 seconds ago):

sessions=20, average-cpu-user/nice/system/idle=0%/0%/0%/100%, memory=34%
FGT6HD3916806098(updated 1 seconds ago):

sessions=163, average-cpu-user/nice/system/idle=0%/0%/0%/100%, memory=34%
HBDEV stats:

FGT6HD3916806070(updated 1 seconds ago):
port3: physical/1000full, up, rx-bytes/pack-

ets/dropped/errors=40755112/71809/0/0, tx=48104698/76943/0/0
port4: physical/1000full, up, rx-bytes/pack-

ets/dropped/errors=29804904/42302/0/0, tx=30030641/42333/0/0
FGT6HD3916806098(updated 1 seconds ago):

port3: physical/1000full, up, rx-bytes/pack-
ets/dropped/errors=47188898/74965/0/0, tx=39680065/69723/0/0

port4: physical/1000full, up, rx-bytes/pack-
ets/dropped/errors=29338501/41347/0/0, tx=29022293/41201/0/0
Slave : Edge2-Backup , FGT6HD3916806070, cluster index = 1
Master: Edge2-Primary , FGT6HD3916806098, cluster index = 0
number of vcluster: 1
vcluster 1: standby 169.254.0.1
Slave : FGT6HD3916806070, operating cluster index = 1
Master: FGT6HD3916806098, operating cluster index = 0

About the HA operating cluster index and the execute ha manage command

When a cluster starts up, if primary unit select is based on serial number, the FortiGate Cluster Protocol (FGCP)
assigns a cluster index and an HA heartbeat IP address to each cluster unit based on the serial number of the
cluster unit:

l The FGCP selects the cluster unit with the highest serial number to become the primary unit. The FGCP assigns a
cluster index of 0, an operating cluster index of 0, and an HA heartbeat IP address of 169.254.0.1 to this unit.
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l The FGCP assigns a cluster index of 1, an operating cluster index of 1, and an HA heartbeat IP address of
169.254.0.2 to the cluster unit with the second highest serial number.

l If the cluster contains more units, the cluster unit with the third highest serial number is assigned a cluster index of
2, and operating cluster index of 2, and an HA heartbeat IP address of 169.254.0.3, and so on.

You can display the cluster index and operating cluster index assigned to each cluster unit using the get
system ha status command. When you use the execute ha manage command you select a cluster unit
to log into by entering its operating cluster index.

The operating cluster index and HA heartbeat IP address only change if a unit leaves the cluster or if a new unit
joins the cluster. When one of these events happens, the FGCP resets the cluster index, operating cluster index,
and HA heartbeat IP address of each cluster unit according to serial number in the same way as when the cluster
first starts up.

If FortiGates don't leave or join, each cluster unit keeps its assigned operating cluster index, and HA heartbeat IP
address since these are based on the FortiGate serial number, even as the units take on different roles in the
cluster. After the operating cluster index and HA heartbeat IP addresses are set according to serial number, the
FGCP checks other primary unit selection criteria such as device priority and monitored interfaces. Checking
these criteria could result in selecting a cluster unit without the highest serial number to operate as the primary
unit.

Even if the cluster unit without the highest serial number now becomes the primary unit, the operating cluster
indexes and HA heartbeat IP addresses assigned to the individual cluster units do not change. Instead the FGCP
changes the cluster index to reflect this role change. The cluster index is always 0 for the primary unit and 1 and
higher for the other units in the cluster. By default both sets of cluster indexes are the same. But if primary unit
selection selects the cluster unit that does not have the highest serial number to be the primary unit, then this
cluster unit is assigned a cluster index of 0.

Using the execute ha manage command

When you use the CLI command execute ha manage <index_integer> to connect to the CLI of another
cluster unit, the <index_integer> that you enter is the operating cluster index of the unit that you want to
connect to.

Using get system ha status to display cluster indexes

You can display the cluster index assigned to each cluster unit using the CLI command get system ha
status. The following example shows the information displayed by the get system ha status command
for a cluster consisting of two FortiGates operating in active-passive HAmode with virtual domains not enabled
and without virtual clustering.

get system ha status
.
.
.
Master: Edge2-Primary , FGT6HD3916806098, cluster index = 0
Slave : Edge2-Backup , FGT6HD3916806070, cluster index = 1
number of vcluster: 1
vcluster 1: work 169.254.0.1
Master: FGT6HD3916806098, operating cluster index = 0
Slave : FGT6HD3916806070, operating cluster index = 1

In this example, the cluster unit with serial number FGT6HD3916806098 has the highest serial number and so
has a cluster index and an operating cluster index of 0 and the cluster unit with serial number
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FGT6HD3916806070 has a cluster index and an operating cluster index of 1. From the CLI of the primary unit of
this cluster you can connect to the CLI of the subordinate unit using the following command:

execute ha manage 1

This works because the cluster unit with serial number FGT6HD3916806070 has a cluster index of 1.

The last three lines of the command output display the status of vcluster 1. In a cluster consisting of two cluster
units operating without virtual domains enabled, all clustering actually takes place in virtual cluster 1. HA is
designed to work this way to support virtual clustering. If this cluster was operating with virtual domains enabled,
adding virtual cluster 2 is similar to adding a new copy of virtual cluster 1. Virtual cluster 2 is visible in the get
system ha status command output when you add virtual domains to virtual cluster 2.

The HA heartbeat IP address displayed by the command is the HA heartbeat IP address of the cluster unit that is
actually operating as the primary unit. For a default configuration, this IP address will always be 169.254.0.1
because the cluster unit with the highest serial number will be the primary unit. This IP address changes if the
operating primary unit is not the primary unit with the highest serial number.

Example where the cluster index and operating cluster index do not match

This example shows get system ha status command output for the same cluster. However, in this
example the device priority of the cluster unit with the serial number FGT6HD3916806098 is increased to 250. As
a result the cluster unit with the lowest serial number becomes the primary unit. This means the cluster index and
the operating cluster index of the cluster units do not match.

get system ha status
.
.
.
Master: Edge2-Primary , FGT6HD3916806098, cluster index = 1
Slave : Edge2-Backup , FGT6HD3916806070, cluster index = 0
number of vcluster: 1
vcluster 1: work 169.254.0.2
Master: FGT6HD3916806098, operating cluster index = 0
Slave : FGT6HD3916806070, operating cluster index = 1

The actual cluster indexes have not changed but the operating cluster indexes have. Also, the HA heartbeat IP
address displayed for vcluster 1 has changed to 169.254.0.2.

Virtual clustering example output

The get system ha status command output is the same if a cluster is operating with virtual clustering
turned on but with all virtual domains in virtual cluster 1. The following get system ha status command
output example shows the same cluster operating as a virtual cluster with virtual domains in virtual cluster 1 and
added to virtual cluster 2. In this example the cluster unit with serial number FG50012204400045 is the primary
unit for virtual cluster 1 and the cluster unit with serial number FG50012205400050 is the primary unit for virtual
cluster 2.

get system ha status
.
.
.
number of vcluster: 2
vcluster 1: work 169.254.0.2
Master: FG50012205400050, operating cluster index = 1
Slave : FG50012204400045, operating cluster index = 0
vcluster 2: standby 169.254.0.1
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Master: FG50012205400050, operating cluster index = 0
Slave : FG50012204400045, operating cluster index = 1

This example shows three sets of indexes. The indexes in lines six and seven are still used by the execute ha
manage command. The indexes on lines ten and eleven are for the primary and subordinate units in virtual
cluster 1 and the indexes on the last two lines are for virtual cluster 2.

Managing individual cluster units
The following procedure describes how to use SSH to log into the primary unit CLI and from there to use the
execute ha manage command to connect to the CLI of any other unit in the cluster. The procedure is very
similar if you use telnet, or the GUI dashboard CLI console.

You can use the execute ha manage command from the CLI of any cluster unit to log into the CLI of another
the cluster unit. Usually you would use this command from the CLI of the primary unit to log into the CLI of a
subordinate unit. However, if you have logged into a subordinate unit CLI, you can use this command to log into
the primary unit CLI, or the CLI of another subordinate unit.

Using SSH or telnet or the GUI CLI console you can only log into the primary unit CLI. Using a direct console
connection you can log into any cluster unit. In both cases you can use execute ha manage to connect to the
CLI of other cluster units.

1. Log into the primary unit CLI.
Connect to any cluster interface configured for SSH administrative access to log into the cluster.

2. Enter the following command followed by a space and type a question mark (?):
execute ha manage

The CLI displays a list of the serial numbers of all of the subordinate units in the cluster. Each cluster
unit is numbered. The number is the operating cluster index.

3. Complete the command with the operating cluster index number of the subordinate unit to log into. For example,
to log into subordinate unit 1, enter the following command:

execute ha manage 1

4. Log into the CLI of the selected subordinate unit.
The CLI prompt changes to the host name of the subordinate unit. You can use CLI commands to
manage this subordinate unit. If you make changes to the configuration of any cluster unit (primary or
subordinate unit) these changes are synchronized to all cluster units.

5. You can now use the execute ha manage command to connect to any other cluster unit (including the primary
unit). You can also use the exit command to return to the primary unit CLI.

Disconnecting a cluster unit from a cluster
Use the following procedures to disconnect a cluster unit from a functioning cluster without disrupting the
operation of the cluster. You can disconnect a cluster unit if you need to use the disconnected FortiGate for
another purpose, such as to act as a standalone firewall.

You can use the following procedures for a standard cluster and for a virtual clustering configuration. To use the
following procedures from a virtual cluster you must be logged in as the admin administrator and you must have
selected Global Configuration.

When you disconnect a cluster unit you must assign an IP address and netmask to one of the interfaces of the
disconnected unit. You can disconnect any unit from the cluster even the primary unit. After the unit is
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disconnected, the cluster responds as if the disconnected unit has failed. The cluster may renegotiate and may
select a new primary unit.

When the cluster unit is disconnected the HAmode is changed to standalone. In addition, all interface IP
addresses of the disconnected unit are set to 0.0.0.0 except for the interface that you configure.

Otherwise the configuration of the disconnected unit is not changed. The HA configuration of the disconnected
unit is not changed either (except to change the HAmode to Standalone).

To disconnect a cluster unit from a cluster - GUI

1. Go to System > HA to view the cluster members list.
2. Select the Disconnect from cluster icon for the cluster unit to disconnect from the cluster.
3. Select the interface that you want to configure. You also specify the IP address and netmask for this interface.

When the FortiGate is disconnected, all management access options are enabled for this interface.
4. Specify an IP address and netmask for the interface. You can use this IP address to connect to the interface to

configure the disconnected FortiGate.
5. Select OK.

The FortiGate is disconnected from the cluster and the cluster may renegotiate and select a new
primary unit. The selected interface of the disconnected unit is configured with the specified IP
address and netmask.

To disconnect a cluster unit from a cluster - CLI

1. Enter the following command to disconnect a cluster unit with serial number FGT5002803033050. The internal
interface of the disconnected unit is set to IP address 1.1.1.1 and netmask 255.255.255.0.

execute ha disconnect FGT5002803033050 internal 1.1.1.1 255.255.255.0

Adding a disconnected FortiGate back to its cluster
If you disconnect a FortiGate from a cluster, you can re-connect the disconnected FortiGate to the cluster by
setting the HAmode of the disconnected unit to match the HAmode of the cluster. Usually the disconnected unit
rejoins the cluster as a subordinate unit and the cluster automatically synchronizes its configuration.

You do not have to change the HA password on the disconnected unit unless the HA
password has been changed after the unit was disconnected. Disconnecting a unit
from a cluster does not change the HA password.

You should make sure that the device priority of the disconnected unit is lower than the
device priority of the current primary unit. You should also make sure that the HA
override CLI option is not enabled on the disconnected unit. Otherwise, when the
disconnected unit joins the cluster, the cluster will renegotiate and the disconnected
unit may become the primary unit. If this happens, the configuration of the
disconnected unit is synchronized to all other cluster units. This configuration change
might disrupt the operation of the cluster.

The following procedure assumes that the disconnected FortiGate is correctly physically connected to your
network and to the cluster but is not running in HAmode and not part of the cluster.

Before you start this procedure you should note the device priority of the primary unit.
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To add a disconnected FortiGate back to its cluster - GUI

1. Log into the disconnected FortiGate.
If virtual domains are enabled, log in as the admin administrator and select Global Configuration.

2. Go to System > HA.
3. Change Mode to match the mode of the cluster.
4. If required, change the group name and password to match the cluster.
5. Set the Device Priority lower than the device priority of the primary unit.
6. Select OK.

The disconnected FortiGate joins the cluster.

To add a disconnected FortiGate back to its cluster - CLI

1. Log into the CLI of the FortiGate to be added back to the cluster.
2. Enter the following command to access the global configuration and add the FortiGate back to a cluster operating

in active-passive mode and set the device priority to 50 (a low number) so that this unit will not become the
primary unit:

config global
config system ha

set mode a-p
set priority 50

end
end

You may have to also change the group name, group id and password. However if you have not
changed these for the cluster or the FortiGate after it was disconnected from the cluster you should
not have to adjust them now.

diagnose sys ha dump-by command
You can use the following diagnose command to display a data about a cluster:

diagnose sys ha dump-by {group | vcluster | rcache | debug-zone | vdom | kernel | device |
stat | sesync}

kernel

This command displays the HA configuration stored by the kernel.

diagnose sys ha dump-by kernel
HA information.

group_id=88, nvcluster=2, mode=2, load_balance=0, schedule=3, ldb_udp=0.
nvcluster=2, mode=2, ses_pickup=0, delay=0, load_balance=0
schedule=3, ldb_udp=0, standalone_ha=0, upgrade_mode=0.
vcluster 1:
FGT51E5618000206, 0, 0.
FGT51E5618000259, 1, 1.
vcluster 2:
FGT51E5618000206, 1, 1.
FGT51E5618000259, 0, 0.
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stat

This command displays some statistics about how well the cluster is functioning. Information includes packet
counts, memory use, failed links and ping failures.

diagnose sys ha dump-by stat
HA information.
packet count = 1, memory = 220.
check_linkfails = 0, linkfails = 0, check_pingsvrfails = 2822
bufcnt = -5, bufmem = 0
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HA and failover protection

In FortiGate active-passive HA, the FortiGate Clustering Protocol (FGCP) provides failover protection. This
means that an active-passive cluster can provide FortiGate services even when one of the cluster units
encounters a problem that would result in complete loss of connectivity for a stand-alone FortiGate. This failover
protection provides a backup mechanism that can be used to reduce the risk of unexpected downtime, especially
in a mission-critical environment.

The FGCP supports three kinds of failover protection. Device failover automatically replaces a failed device and
restarts traffic flow with minimal impact on the network. Link failover maintains traffic flow if a link fails. Session
failover resumes communication sessions with minimal loss of data if a device or link failover occurs.

This chapter describes how FGCP failover protection works and provides detailed NAT and transparent mode
packet flow descriptions.

About active-passive failover
To achieve failover protection in an active-passive cluster, one of the cluster units functions as the primary unit,
while the rest of the cluster units are subordinate units, operating in an active stand-by mode. The cluster IP
addresses and HA virtual MAC addresses are associated with the cluster interfaces of the primary unit. All traffic
directed at the cluster is actually sent to and processed by the primary unit.

While the cluster is functioning, the primary unit functions as the FortiGate network security device for the
networks that it is connected to. In addition, the primary unit and subordinate units use the HA heartbeat to keep
in constant communication. The subordinate units report their status to the cluster unit and receive and store
connection and state table updates.

Device failure

If the primary unit encounters a problem that is severe enough to cause it to fail, the remaining cluster units
negotiate to select a new primary unit. This occurs because all of the subordinate units are constantly waiting to
negotiate to become primary units. Only the heartbeat packets sent by the primary unit keep the subordinate
units from becoming primary units. Each received heartbeat packet resets negotiation timers in the subordinate
units. If this timer is allowed to run out because the subordinate units do not receive heartbeat packets from the
primary unit, the subordinate units assume that the primary unit has failed, and negotiate to become primary
units themselves.

Using the same FGCP negotiation process that occurs when the cluster starts up, after they determine that the
primary unit has failed, the subordinate units negotiate amongst themselves to select a new primary unit. The
subordinate unit that wins the negotiation becomes the new primary unit with the same MAC and IP addresses as
the former primary unit. The new primary unit then sends gratuitous ARP packets out all of its interfaces to inform
attached switches to send traffic to the new primary unit. Sessions then resume with the new primary unit.

Link failure

If a primary unit interface fails or is disconnected while a cluster is operation, a link failure occurs. When a link
failure occurs the cluster units negotiate to select a new primary unit. Since the primary unit has not stopped
operating, it participates in the negotiation. The link failure means that a new primary unit must be selected and
the cluster unit with the link failure joins the cluster as a subordinate unit.
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Just as for a device failover, the new primary unit sends gratuitous arp packets out all of its interfaces to inform
attached switches to send traffic to it. Sessions then resume with the new primary unit.

If a subordinate unit experiences a device failure its status in the cluster does not change. However, in future
negotiations a cluster unit with a link failure is unlikely to become the primary unit.

Session failover

If you enable session failover (also called session pickup) for the cluster, during cluster operation the primary unit
informs the subordinate units of changes to the primary unit connection and state tables, keeping the subordinate
units up-to-date with the traffic currently being processed by the cluster.

After a failover the new primary unit recognizes open sessions that were being handled by the cluster. The
sessions continue to be processed by the new primary unit and are handled according to their last known state.

If you leave session pickup disabled, the cluster does not keep track of sessions and after a failover, active
sessions have to be restarted or resumed.

Primary unit recovery

If a primary unit recovers after a device or link failure, it will operate as a subordinate unit, unless the override
CLI keyword is enabled and its device priority is set higher than the unit priority of other cluster units (see HA
override on page 1752).

About active-active failover
HA failover in a cluster running in active-active mode is similar to active-passive failover described above. Active-
active subordinate units are constantly waiting to negotiate to become primary units and, if session failover is
enabled, continuously receive connection state information from the primary unit. If the primary unit fails, or one
of the primary unit interfaces fails, the cluster units use the same mechanisms to detect the failure and to
negotiate to select a new primary unit. If session failover is enabled, the new primary unit also maintains
communication sessions through the cluster using the shared connection state table.

Active-active HA load balances sessions among all cluster units. For session failover, the cluster must maintain
all of these sessions. To load balance sessions, the functioning cluster uses a load balancing schedule to
distribute sessions to all cluster units. The shared connection state table tracks the communication sessions
being processed by all cluster units (not just the primary unit). After a failover, the new primary unit uses the load
balancing schedule to re-distribute all of the communication sessions recorded in the shared connection state
table among all of the remaining cluster units. The connections continue to be processed by the cluster, but
possibly by a different cluster unit, and are handled according to their last known state.

Device failover
The FGCP provides transparent device failover. Device failover is a basic requirement of any highly available
system. Device failover means that if a device fails, a replacement device automatically takes the place of the
failed device and continues operating in the same manner as the failed device.

In the case of FortiOS HA, the device is the primary unit. If the primary unit fails, device failover ensures that one
of the subordinate units in the cluster automatically takes the place of the primary unit and can continue
processing network traffic in the same way as the failed primary unit.
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Device failover does not maintain communication sessions. After a device failover,
communication sessions have to be restarted. To maintain communication sessions, you
must enable session failover. See Device failover on page 1910.

FortiGate HA device failover is supported by the HA heartbeat, virtual MAC addresses, configuration
synchronization, route synchronization and IPsec VPN SA synchronization.

The HA heartbeat makes sure that the subordinate units detect a primary unit failure. If the primary unit fails to
respond on time to HA heartbeat packets the subordinate units assume that the primary unit has failed and
negotiate to select a new primary unit.

The new primary unit takes the place of the failed primary unit and continues functioning in the same way as the
failed primary unit. For the new primary unit to continue functioning like the failed primary unit, the new primary
unit must be able to reconnect to network devices and the new primary unit must have the same configuration as
the failed primary unit.

FortiGate HA uses virtual MAC addresses to reconnect the new primary unit to network devices. The FGCP
causes the new primary unit interfaces to acquire the same virtual MAC addresses as the failed primary unit. As a
result, the new primary unit has the same network identity as the failed primary unit.

The new primary unit interfaces have different physical connections than the failed primary unit. Both the failed
and the new primary unit interfaces are connected to the same switches, but the new primary unit interfaces are
connected to different ports on these switches. To make sure that the switches send packets to the new primary
unit, the new primary unit interfaces send gratuitous ARP packets to the connected switches. These gratuitous
ARP packets notify the switches that the primary unit MAC and IP addresses are on different switch ports and
cause the switches to send packets to the ports connected to the new primary unit. In this way, the new primary
unit continues to receive packets that would otherwise have been sent to the failed primary unit.

Configuration synchronization means that the new primary unit always has the same configuration as the failed
primary unit. As a result the new primary unit operates in exactly the same way as the failed primary unit. If
configuration synchronization were not available the new primary unit may not process network traffic in the same
way as the failed primary unit.

Kernel routing table synchronization synchronizes the primary unit kernel routing table to all subordinate units so
that after a failover the new primary unit does not have to form a completely new routing table. IPsec VPN SA
synchronization synchronizes IPsec VPN security associations (SAs) and other IPsec session data so that after a
failover the new primary unit can resume IPsec tunnels without having to establish new SAs.

HA heartbeat and communication between cluster units
The HA heartbeat keeps cluster units communicating with each other. The heartbeat consists of hello packets
that are sent at regular intervals by the heartbeat interface of all cluster units. These hello packets describe the
state of the cluster unit and are used by other cluster units to keep all cluster units synchronized.

HA heartbeat packets are non-TCP packets that use Ethertype values 0x8890, 0x8891, and 0x8893. The default
time interval between HA heartbeats is 200 ms. The FGCP uses link-local IPv4 addresses in the 169.254.0.x
range for HA heartbeat interface IP addresses.

For best results, isolate the heartbeat devices from your user networks by connecting the heartbeat devices to a
separate switch that is not connected to any network. If the cluster consists of two FortiGates you can connect the
heartbeat device interfaces directly using a crossover cable. Heartbeat packets contain sensitive information
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about the cluster configuration. Heartbeat packets may also use a considerable amount of network bandwidth.
For these reasons, it is preferable to isolate heartbeat packets from your user networks.

On startup, a FortiGate configured for HA operation broadcasts HA heartbeat hello packets from its HA heartbeat
interface to find other FortiGates configured to operate in HAmode. If two or more FortiGates operating in HA
mode connect with each other, they compare HA configurations (HAmode, HA password, and HA group ID). If
the HA configurations match, the units negotiate to form a cluster.

While the cluster is operating, the HA heartbeat confirms that all cluster units are functioning normally. The
heartbeat also reports the state of all cluster units, including the communication sessions that they are
processing.

Heartbeat interfaces

A heartbeat interface is an Ethernet network interface in a cluster that is used by the FGCP for HA heartbeat
communications between cluster units.

To change the HA heartbeat configuration go to System > HA and select the FortiGate interfaces to use as HA
heartbeat interfaces.

Do not use a switch port for the HA heartbeat traffic. This configuration is not supported.

From the CLI enter the following command to make port4 and port5 HA heartbeat interfaces and give both
interfaces a heartbeat priority of 150:

config system ha
set hbdev port4 150 port5 150

end

The following example shows how to change the default heartbeat interface configuration so that the port4 and
port1 interfaces can be used for HA heartbeat communication and to give the port4 interface the highest
heartbeat priority so that port4 is the preferred HA heartbeat interface.

config system ha
set hbdev port4 100 port1 50

end

By default, for most FortiGate models two interfaces are configured to be heartbeat interfaces. You can change
the heartbeat interface configuration as required. For example you can select additional or different heartbeat
interfaces. You can also select only one heartbeat interface.

In addition to selecting the heartbeat interfaces, you also set the Priority for each heartbeat interface. In all
cases, the heartbeat interface with the highest priority is used for all HA heartbeat communication. If the interface
fails or becomes disconnected, the selected heartbeat interface that has the next highest priority handles all
heartbeat communication.

If more than one heartbeat interface has the same priority, the heartbeat interface with the highest priority that is
also highest in the heartbeat interface list is used for all HA heartbeat communication. If this interface fails or
becomes disconnected, the selected heartbeat interface with the highest priority that is next highest in the list
handles all heartbeat communication.

The default heartbeat interface configuration sets the priority of two heartbeat interfaces to 50. You can accept
the default heartbeat interface configuration if one or both of the default heartbeat interfaces are connected. You
can select different heartbeat interfaces, select more heartbeat interfaces and change heartbeat priorities
according to your requirements.
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For the HA cluster to function correctly, you must select at least one heartbeat interface and this interface of all of
the cluster units must be connected together. If heartbeat communication is interrupted and cannot failover to a
second heartbeat interface, the cluster units will not be able to communicate with each other and more than one
cluster unit may become a primary unit. As a result the cluster stops functioning normally because multiple
devices on the network may be operating as primary units with the same IP and MAC addresses creating a kind if
split brain scenario.

The heartbeat interface priority range is 0 to 512. The default priority when you select a new heartbeat interface is
0. The higher the number the higher the priority.

In most cases you can maintain the default heartbeat interface configuration as long as you can connect the
heartbeat interfaces together. Configuring HA heartbeat interfaces is the same for virtual clustering and for
standard HA clustering.

You can enable heartbeat communications for physical interfaces, but not for VLAN subinterfaces, IPsec VPN
interfaces, redundant interfaces, or for 802.3ad aggregate interfaces. You cannot select these types of interfaces
in the heartbeat interface list.

Selecting more heartbeat interfaces increases reliability. If a heartbeat interface fails or is disconnected, the HA
heartbeat fails over to the next heartbeat interface.

You can select up to 8 heartbeat interfaces. This limit only applies to FortiGates with more than 8 physical
interfaces.

HA heartbeat traffic can use a considerable amount of network bandwidth. If possible, enable HA heartbeat traffic
on interfaces used only for HA heartbeat traffic or on interfaces connected to less busy networks.

Connecting HA heartbeat interfaces

For most FortiGate models if you do not change the heartbeat interface configuration, you can isolate the default
heartbeat interfaces of all of the cluster units by connecting them all to the same switch. Use one switch per
heartbeat interface. If the cluster consists of two units you can connect the heartbeat interfaces together using
crossover cables.

HA heartbeat and data traffic are supported on the same cluster interface. In NAT mode, if you decide to use
heartbeat interfaces for processing network traffic or for a management connection, you can assign the interface
any IP address. This IP address does not affect HA heartbeat traffic.

In transparent mode, you can connect the heartbeat interface to your network and enable management access.
You would then establish a management connection to the interface using the transparent mode management IP
address. This configuration does not affect HA heartbeat traffic.

Heartbeat packets and heartbeat interface selection

HA heartbeat hello packets are constantly sent by all of the enabled heartbeat interfaces. Using these hello
packets, each cluster unit confirms that the other cluster units are still operating. The FGCP selects one of the
heartbeat interfaces to be used for communication between the cluster units. The FGCP selects the heartbeat
interface for heartbeat communication based on the linkfail states of the heartbeat interfaces, on the priority of
the heartbeat interfaces, and on the interface index.

The FGCP checks the linkfail state of all heartbeat interfaces to determine which ones are connected. The FGCP
selects one of these connected heartbeat interfaces to be the one used for heartbeat communication. The FGCP
selects the connected heartbeat interface with the highest priority for heartbeat communication.
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If more than one connected heartbeat interface has the highest priority the FGCP selects the heartbeat interface
with the lowest interface index. The GUI lists the FortiGate interfaces in alphabetical order. This order
corresponds to the interface index order with lowest index at the top and highest at the bottom. If more than one
heartbeat interface has the highest priority, the FGCP selects the interface that is highest in the heartbeat
interface list (or first in alphabetical order) for heartbeat communication.

If the interface that is processing heartbeat traffic fails or becomes disconnected, the FGCP uses the same
criteria to select another heartbeat interface for heartbeat communication. If the original heartbeat interface is
fixed or reconnected, the FGCP again selects this interface for heartbeat communication.

The HA heartbeat communicates cluster session information, synchronizes the cluster configuration,
synchronizes the cluster kernel routing table, and reports individual cluster member status. The HA heartbeat
constantly communicates HA status information to make sure that the cluster is operating properly.

Interface index and display order

The GUI and CLI display interface names in alphanumeric order. For example, the sort order for a FortiGate with
10 interfaces (named port1 through port10) places port10 at the bottom of the list:

l port1
l port2 through 9
l port10

However, interfaces are indexed in hash map order, rather than purely by alphabetic order or purely by interface
number value comparisons. As a result, the list is sorted primarily alphabetical by interface name (for example,
base1 is before port1), then secondarily by index numbers:

l port1
l port10
l port2 through port9

HA heartbeat interface IP addresses

The FGCP uses link-local IPv4 addresses (RFC 3927) in the 169.254.0.x range for HA heartbeat interface IP
addresses and for inter-VDOM link interface IP addresses. When a cluster initially starts up, the primary unit
heartbeat interface IP address is 169.254.0.1. Subordinate units are assigned heartbeat interface IP addresses in
the range 169.254.0.2 to 169.254.0.63. HA inter-VDOM link interfaces on the primary unit are assigned IP
addresses 169.254.0.65 and 169.254.0.66.

If a failover occurs, the primary unit heartbeat interface could be something other than 169.254.0.1. If for
example, the first subordinate unit is now the primary unit, the primary unit heartbeat interface IP address would
be 169.254.0.2.

The output from the get system ha status CLI command shows the HA heartbeat interface IP address of
the primary unit.

get system ha status
.
.
.
vcluster 1: work 169.254.0.2
.
.
.
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You can also use the execute traceroute command from the subordinate unit CLI to display HA heartbeat
IP addresses and the HA inter-VDOM link IP addresses. For example, use execute ha manage 1 to connect
to the subordinate unit CLI and then enter the following command to trace the route to an IP address on your
network:

execute traceroute 172.20.20.10
traceroute to 172.20.20.10 (172.20.20.10), 32 hops max, 72 byte packets

1 169.254.0.1 0 ms 0 ms 0 ms
2 169.254.0.66 0 ms 0 ms 0 ms
3 172.20.20.10 0 ms 0 ms 0 ms

Both HA heartbeat and data traffic are supported on the same FortiGate interface. All heartbeat communication
takes place on a separate VDOM called vsys_ha. Heartbeat traffic uses a virtual interface called port_ha in the
vsys_ha VDOM. Data and heartbeat traffic use the same physical interface, but they’re logically separated into
separate VDOMs.

Heartbeat packet Ethertypes

Normal IP packets are 802.3 packets that have an Ethernet type (Ethertype) field value of 0x0800. Ethertype
values other than 0x0800 are understood as level 2 frames rather than IP packets.

By default, HA heartbeat packets use the following Ethertypes:

l HA heartbeat packets for NAT mode clusters use Ethertype 0x8890. These packets are used by cluster units to find
other cluster units and to verify the status of other cluster units while the cluster is operating. You can change the
Ethertype of these packets using the ha-eth-type option of the config system ha command.

l HA heartbeat packets for transparent mode clusters use Ethertype 0x8891. These packets are used by cluster units
to find other cluster units and to verify the status of other cluster units while the cluster is operating. You can change
the Ethertype of these packets using the hc-eth-type option of the config system ha command.

l HA telnet sessions between cluster units over HA heartbeat links use Ethertype 0x8893. The telnet sessions allow
an administrator to connect between FortiGates in the cluster using the execute ha manage command. You
can change the Ethertype of these packets using the l2ep-eth-type option of the config system ha
command.

Because heartbeat packets are recognized as level 2 frames, the switches and routers on your heartbeat network
that connect to heartbeat interfaces must be configured to allow them. If level2 frames are dropped by these
network devices, heartbeat traffic will not be allowed between the cluster units.

Some third-party network equipment may use packets with these Ethertypes for other purposes. For example,
Cisco N5K/Nexus switches use Ethertype 0x8890 for some functions. When one of these switches receives
Ethertype 0x8890 packets from an attached cluster unit, the switch generates CRC errors and the packets are not
forwarded. As a result, FortiGates connected with these switches cannot form a cluster.

In some cases, if the heartbeat interfaces are connected and configured so regular traffic flows but heartbeat
traffic is not forwarded, you can change the configuration of the switch that connects the HA heartbeat interfaces
to allow level2 frames with Ethertypes 0x8890, 0x8891, and 0x8893 to pass.

Alternatively, you can use the following CLI options to change the Ethertypes of the HA heartbeat packets:

config system ha
set ha-eth-type <ha_ethertype_4-digit_hex
set hc-eth-type <hc_ethertype_4-digit_ex>
set l2ep-eth-type <l2ep_ethertype_4-digit_hex>

end

For example, use the following command to change the Ethertype of the HA heartbeat packets from 0x8890 to
0x8895 and to change the Ethertype of HA Telnet session packets from 0x8891 to 0x889f:
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config system ha
set ha-eth-type 8895
set l2ep-eth-type 889f

end

Modifying heartbeat timing

In an HA cluster, if a cluster unit CPU becomes very busy, the cluster unit may not be able to send heartbeat
packets on time. If heartbeat packets are not sent on time other units in the cluster may think that the cluster unit
has failed and the cluster will experience a failover.

A cluster unit CPU may become very busy if the cluster is subject to a syn flood attack, if network traffic is very
heavy, or for other similar reasons. You can use the following CLI commands to configure how the cluster times
HA heartbeat packets:

config system ha
set hb-interval <interval_integer>
set hb-lost-threshold <threshold_integer>
set hello-holddown <holddown_integer>

end

Changing the lost heartbeat threshold

The lost heartbeat threshold is the number of consecutive heartbeat packets that are not received from another
cluster unit before assuming that the cluster unit has failed. The default value is 6, meaning that if the 6
heartbeat packets are not received from a cluster unit then that cluster unit is considered to have failed. The
range is 1 to 60 packets.

If the primary unit does not receive a heartbeat packet from a subordinate unit before the heartbeat threshold
expires, the primary unit assumes that the subordinate unit has failed.

If a subordinate unit does not receive a heartbeat packet from the primary unit before the heartbeat threshold
expires, the subordinate unit assumes that the primary unit has failed. The subordinate unit then begins
negotiating to become the new primary unit.

The lower the hb-lost-threshold the faster a cluster responds when a unit fails. However, sometimes
heartbeat packets may not be sent because a cluster unit is very busy. This can lead to a false positive failure
detection. To reduce these false positives you can increase the hb-lost-threshold.

Use the following CLI command to increase the lost heartbeat threshold to 12:

config system ha
set hb-lost-threshold 12

end

Changing the heartbeat interval

The heartbeat interval is the time between sending HA heartbeat packets. The heartbeat interval range is 1 to 20
(100*ms). The heartbeat interval default is 2 (200 ms).

A heartbeat interval of 2 means the time between heartbeat packets is 200 ms. Changing the heartbeat interval
to 5 changes the time between heartbeat packets to 500 ms (5 * 100ms = 500ms).

The HA heartbeat packets consume more bandwidth if the heartbeat interval is short. But if the heartbeat interval
is very long, the cluster is not as sensitive to topology and other network changes.

Use the following CLI command to increase the heartbeat interval to 10:
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config system ha
set hb-interval 10

end

The heartbeat interval combines with the lost heartbeat threshold to set how long a cluster unit waits before
assuming that another cluster unit has failed and is no longer sending heartbeat packets. By default, if a cluster
unit does not receive a heartbeat packet from a cluster unit for 6 * 200 = 1200 milliseconds or 1.2 seconds the
cluster unit assumes that the other cluster unit has failed.

You can increase both the heartbeat interval and the lost heartbeat threshold to reduce false positives. For
example, increasing the heartbeat interval to 20 and the lost heartbeat threshold to 30 means a failure will be
assumed if no heartbeat packets are received after 30 * 2000 milliseconds = 60,000 milliseconds, or 60 seconds.

Use the following CLI command to increase the heartbeat interval to 20 and the lost heartbeat threshold to 30:

config system ha
set hb-lost-threshold 20
set hb-interval 30

end

Changing the time to wait in the hello state

The hello state hold-down time is the number of seconds that a cluster unit waits before changing from hello state
to work state. After a failure or when starting up, cluster units operate in the hello state to send and receive
heartbeat packets so that all the cluster units can find each other and form a cluster. A cluster unit should change
from the hello state to work state after it finds all of the other FortiGates to form a cluster with. If for some reason
all cluster units cannot find each other during the hello state then some cluster units may be joining the cluster
after it has formed. This can cause disruptions to the cluster and affect how it operates.

One reason for a delay in all of the cluster units joining the cluster could be the cluster units are located at
different sites of if for some other reason communication is delayed between the heartbeat interfaces.

If cluster units are joining your cluster after it has started up of if it takes a while for units to join the cluster you can
increase the time that the cluster units wait in the hello state. The hello state hold-down time range is 5 to 300
seconds. The hello state hold-down time default is 20 seconds.

Use the following CLI command to increase the time to wait in the hello state to 1 minute (60 seconds):

config system ha
set hello-holddown 60

end

Enabling or disabling HA heartbeat encryption and authentication

You can enable HA heartbeat encryption and authentication to encrypt and authenticate HA heartbeat packets.
HA heartbeat packets should be encrypted and authenticated if the cluster interfaces that send HA heartbeat
packets are also connected to your networks.

If HA heartbeat packets are not encrypted the cluster password and changes to the cluster configuration could be
exposed and an attacker may be able to sniff HA packets to get cluster information. Enabling HA heartbeat
message authentication prevents an attacker from creating false HA heartbeat messages. False HA heartbeat
messages could affect the stability of the cluster.

HA heartbeat encryption and authentication are disabled by default. Enabling HA encryption and authentication
could reduce cluster performance. Use the following CLI command to enable HA heartbeat encryption and
authentication.

config system ha
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set authentication enable
set encryption enable

end

HA authentication and encryption uses AES-128 for encryption and SHA1 for authentication.

Heartbeat bandwidth requirements

The majority of the traffic processed by the HA heartbeat interface is session synchronization traffic. Other
heartbeat interface traffic required to synchronize IPsec state/keys, routing tables, configuration changes, and so
on is usually negligible.

The amount of traffic required for session synchronization depends on the connections per second (CPS) that the
cluster is processing since only new sessions (and session table updates) need to be synchronized.

Another factor to consider is that if session pickup is enabled, traffic on the heartbeat interface surges during a
failover or when a unit joins or re-joins the cluster. When one of these events happens, the whole session table
needs to be synchronized. Lower bandwith HA heartbeat interfaces may increase failover time if they can't handle
the higher demand during these events.

You can also reduce the amount of heartbeat traffic by:

l Turning off session pickup if you don't need it,
l Configuring session-pickup-delay to reduce the number of sessions that are synchronized,
l Using the session-sync-dev option to move session synchronization traffic off of the heartbeat link.

See Improving session synchronization performance on page 1954 for details.

Cluster virtual MAC addresses
When a cluster is operating, the FGCP assigns virtual MAC addresses to each primary unit interface. HA uses
virtual MAC addresses so that if a failover occurs, the new primary unit interfaces will have the same virtual MAC
addresses and IP addresses as the failed primary unit. As a result, most network equipment would identify the
new primary unit as the exact same device as the failed primary unit.

If the MAC addresses changed after a failover, the network would take longer to recover because all attached
network devices would have to learn the new MAC addresses before they could communicate with the cluster.

If a cluster is operating in NAT mode, the FGCP assigns a different virtual MAC address to each primary unit
interface. VLAN subinterfaces are assigned the same virtual MAC address as the physical interface that the VLAN
subinterface is added to. Redundant interfaces or 802.3ad aggregate interfaces are assigned the virtual MAC
address of the first interface in the redundant or aggregate list.

If a cluster is operating in transparent mode, the FGCP assigns a virtual MAC address for the primary unit
management IP address. Since you can connect to the management IP address from any interface, all of the
FortiGate interfaces appear to have the same virtual MAC address.

AMAC address conflict can occur if two clusters are operating on the same network. See
Diagnosing packet loss with two FortiGate HA clusters in the same broadcast domain on
page 1923 for more information.

Subordinate unit MAC addresses do not change. You can verify this by connecting to the
subordinate unit CLI and using the get hardware interface nic command to
display the MAC addresses of each FortiGate interface.
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The MAC address of a reserved management interface is not changed to a virtual MAC
address. Instead the reserved management interface keeps its original MAC address.

When the new primary unit is selected after a failover, the primary unit sends gratuitous ARP packets to update
the devices connected to the cluster interfaces (usually layer-2 switches) with the virtual MAC address. Gratuitous
ARP packets configure connected network devices to associate the cluster virtual MAC addresses and cluster IP
address with primary unit physical interfaces and with the layer-2 switch physical interfaces. This is sometimes
called using gratuitous ARP packets (sometimes called GARP packets) to train the network. The gratuitous ARP
packets sent from the primary unit are intended to make sure that the layer-2 switch forwarding databases (FDBs)
are updated as quickly as possible.

Sending gratuitous ARP packets is not required for routers and hosts on the network because the new primary
unit will have the same MAC and IP addresses as the failed primary unit. However, since the new primary unit
interfaces are connected to different switch interfaces than the failed primary unit, many network switches will
update their FDBsmore quickly after a failover if the new primary unit sends gratuitous ARP packets.

Changing how the primary unit sends gratuitous ARP packets after a failover

When a failover occurs it is important that the devices connected to the primary unit update their FDBs as quickly
as possible to reestablish traffic forwarding.

Depending on your network configuration, you may be able to change the number of gratuitous ARP packets and
the time interval between ARP packets to reduce the cluster failover time.

You cannot disable sending gratuitous ARP packets, but you can use the following command to change the
number of packets that are sent. For example, enter the following command to send 20 gratuitous ARP packets:

config system ha
set arps 20

end

You can use this command to configure the primary unit to send from 1 to 60 ARP packets. Usually you would not
change the default setting of 5. In some cases, however, you might want to reduce the number of gratuitous ARP
packets. For example, if your cluster has a large number of VLAN interfaces and virtual domains and because
gratuitous ARP packets are broadcast, sending a higher number gratuitous ARP packets may generate a lot of
network traffic. As long as the cluster still fails over successfully, you could reduce the number of gratuitous ARP
packets that are sent to reduce the amount of traffic produced after a failover.

If failover is taking longer that expected, you may be able to reduce the failover time by increasing the number
gratuitous ARP packets sent.

You can also use the following command to change the time interval in seconds between gratuitous ARP packets.
For example, enter the following command to change the time between ARP packets to 3 seconds:

config system ha
set arps-interval 3

end

The time interval can be in the range of 1 to 20 seconds. The default is 8 seconds between gratuitous ARP
packets. Normally you would not need to change the time interval. However, you could decrease the time to be
able send more packets in less time if your cluster takes a long time to failover.

There may also be a number of reasons to set the interval higher. For example, if your cluster has a large number
of VLAN interfaces and virtual domains and because gratuitous ARP packets are broadcast, sending gratuitous
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ARP packets may generate a lot of network traffic. As long as the cluster still fails over successfully you could
increase the interval to reduce the amount of traffic produced after a failover.

For more information about gratuitous ARP packets see RFC 826 and RFC 3927.

Disabling gratuitous ARP packets after a failover

You can use the following command to turn off sending gratuitous ARP packets after a failover:

config system ha
set gratuitous-arps disable

end

Sending gratuitous ARP packets is turned on by default.

In most cases you would want to send gratuitous ARP packets because its a reliable way for the cluster to notify
the network to send traffic to the new primary unit. However, in some cases, sending gratuitous ARP packets may
be less optimal. For example, if you have a cluster of FortiGates in transparent mode, after a failover the new
primary unit will send gratuitous ARP packets to all of the addresses in its Forwarding Database (FDB). If the FDB
has a large number of addresses it may take extra time to send all the packets and the sudden burst of traffic
could disrupt the network.

If you choose to disable sending gratuitous ARP packets you must first enable the link-failed-signal
setting. The cluster must have some way of informing attached network devices that a failover has occurred.

For more information about the link-failed-signal setting, see Updating MAC forwarding tables when a
link failover occurs on page 1940.

How the virtual MAC address is determined

The virtual MAC address is determined based on following formula:

00-09-0f-09-<group-id_hex>-(<vcluster_integer> + <idx>)

where

<group-id_hex> is the HAGroup ID for the cluster converted to hexadecimal.The following table lists the
virtual MAC address set for each group ID.

HA group ID in integer and hexadecimal format

Integer Group ID Hexadecimal Group ID

0 00

1 01

2 02

3 03

4 04

... ...
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Integer Group ID Hexadecimal Group ID

10 0a

11 0b

... ...

63 3f

... ...

255 ff

<vcluster_integer> is 0 for virtual cluster 1 and 20 for virtual cluster 2. If virtual domains are not enabled,
HA sets the virtual cluster to 1 and by default all interfaces are in the root virtual domain. Including virtual cluster
and virtual domain factors in the virtual MAC address formula means that the same formula can be used whether
or not virtual domains and virtual clustering is enabled.

<idx> is the index number of the interface. Interfaces are numbered from 0 to x (where x is the number of
interfaces). Interfaces are numbered according to their has map order. See Interface index and display order on
page 1914. The first interface has an index of 0. The second interface in the list has an index of 1 and so on.

Only the <idx> part of the virtual MAC address is different for each interface. The
<vcluster_integer> would be different for different interfaces if multiple VDOMs have
been added.

Between FortiOS releases interface indexing may change so the virtual MAC addresses
assigned to individual FortiGate interfaces may also change.

Example virtual MAC addresses

An HA cluster with HA group ID unchanged (default=0) and virtual domains not enabled would have the following
virtual MAC addresses for interfaces port1 to port12:

l port1 virtual MAC: 00-09-0f-09-00-00
l port10 virtual MAC: 00-09-0f-09-00-01
l port2 virtual MAC: 00-09-0f-09-00-02
l port3 virtual MAC: 00-09-0f-09-00-03
l port4 virtual MAC: 00-09-0f-09-00-04
l port5 virtual MAC: 00-09-0f-09-00-05
l port6 virtual MAC: 00-09-0f-09-00-06
l port7 virtual MAC: 00-09-0f-09-00-07
l port8 virtual MAC: 00-09-0f-09-00-08
l port9 virtual MAC: 00-09-0f-09-00-
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l port11 virtual MAC: 00-09-0f-09-00-0a
l port12 virtual MAC: 00-09-0f-09-00-0b

If the group ID is changed to 34 these virtual MAC addresses change to:

l port1 virtual MAC: 00-09-0f-09-22-00
l port3 virtual MAC: 00-09-0f-09-22-03
l port4 virtual MAC: 00-09-0f-09-22-04
l port5 virtual MAC: 00-09-0f-09-22-05
l port6 virtual MAC: 00-09-0f-09-22-06
l port7 virtual MAC: 00-09-0f-09-22-07
l port8 virtual MAC: 00-09-0f-09-22-08
l port9 virtual MAC: 00-09-0f-09-22-
l port11 virtual MAC: 00-09-0f-09-22-0a
l port12 virtual MAC: 00-09-0f-09-22-0b
l port10 virtual MAC: 00-09-0f-09-22-01
l port2 virtual MAC: 00-09-0f-09-22-02

A cluster with virtual domains enabled where the HA group ID has been changed to 23, port5 and port 6 are in the
root virtual domain (which is in virtual cluster1), and port7 and port8 are in the vdom_1 virtual domain (which is in
virtual cluster 2) would have the following virtual MAC addresses:

l port5 interface virtual MAC: 00-09-0f-09-23-05
l port6 interface virtual MAC: 00-09-0f-09-23-06
l port7 interface virtual MAC: 00-09-0f-09-23-27
l port8 interface virtual MAC: 00-09-0f-09-23-28

Displaying the virtual MAC address

Every FortiGate physical interface has two MAC addresses: the current hardware address and the permanent
hardware address. The permanent hardware address cannot be changed, it is the actual MAC address of the
interface hardware. The current hardware address can be changed. The current hardware address is the address
seen by the network. For a FortiGate not operating in HA, you can use the following command to change the
current hardware address of the port1 interface:

config system interface
edit port1

set macaddr <mac_address>
end

end

For an operating cluster, the current hardware address of each cluster unit interface is changed to the HA virtual
MAC address by the FGCP. The macaddr option is not available for a functioning cluster. You cannot change an
interface MAC address and you cannot view MAC addresses from the system interface CLI command.

You can use the get hardware nic <interface_name_str> command to display both MAC addresses
for any FortiGate interface. This command displays hardware information for the specified interface. Depending
on their hardware configuration, this command may display different information for different interfaces. You can
use this command to display the current hardware address as Current_HWaddr and the permanent hardware
address as Permanent_HWaddr. For some interfaces the current hardware address is displayed as MAC. The
command displays a great deal of information about the interface so you may have to scroll the output to find the
hardware addresses.
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You can also use the diagnose hardware deviceinfo nic <interface_str>
command to display both MAC addresses for any FortiGate interface.

Before HA configuration the current and permanent hardware addresses are the same. For example for one of
the units in Cluster_1:

FGT60B3907503171 # get hardware nic internal
.
.
.
MAC: 02:09:0f:78:18:c9
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

During HA operation the current hardware address becomes the HA virtual MAC address, for example for the
units in Cluster_1:

FGT60B3907503171 # get hardware nic internal
.
.
.
MAC: 00:09:0f:09:00:02
Permanent_HWaddr: 02:09:0f:78:18:c9
.
.
.

The following command output for Cluster_2 shows the same current hardware address for port1 as for the
internal interface of Cluster_2, indicating a MAC address conflict.

FG300A2904500238 # get hardware nic port1
.
.
.
MAC: 00:09:0f:09:00:02
Permanent_HWaddr: 00:09:0F:85:40:FD
.
.
.

Diagnosing packet loss with two FortiGate HA clusters in the same broadcast domain

A network may experience packet loss when two FortiGate HA clusters have been deployed in the same
broadcast domain. Deploying two HA clusters in the same broadcast domain can result in packet loss because of
MAC address conflicts. The packet loss can be diagnosed by pinging from one cluster to the other or by pinging
both of the clusters from a device within the broadcast domain. You can resolve the MAC address conflict by
changing the HAGroup ID configuration of the two clusters. The HAGroup ID is sometimes also called the
Cluster ID.

This section describes a topology that can result in packet loss, how to determine if packets are being lost, and
how to correct the problem by changing the HAGroup ID.
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Packet loss on a network can also be caused by IP address conflicts. Finding and fixing IP
address conflicts can be difficult. However, if you are experiencing packet loss and your
network contains two FortiGate HA clusters you can use the information in this article to
eliminate one possible source of packet loss.

Changing the HA group ID to avoid MAC address conflicts

Change the Group ID to change the virtual MAC address of all cluster interfaces. You can change the Group ID
from the FortiGate CLI using the following command:

config system ha
set group-id <id_integer>

end

Example topology

The topology below shows two clusters. The Cluster_1 internal interfaces and the Cluster_2 port 1 interfaces are
both connected to the same broadcast domain. In this topology the broadcast domain could be an internal
network. Both clusters could also be connected to the Internet or to different networks.

Example HA topology with possible MAC address conflicts
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Ping testing for packet loss

If the network is experiencing packet loss, it is possible that you will not notice a problem unless you are
constantly pinging both HA clusters. During normal operation of the network you also might not notice packet loss
because the loss rate may not be severe enough to timeout TCP sessions. Also many common types if TCP
traffic, such as web browsing, may not be greatly affected by packet loss. However, packet loss can have a
significant effect on real time protocols that deliver audio and video data.

To test for packet loss you can set up two constant ping sessions, one to each cluster. If packet loss is occurring
the two ping sessions should show alternating replies and timeouts from each cluster.

Cluster_1 Cluster_2

reply timeout

reply timeout

reply timeout

timeout reply

timeout reply

reply timeout

reply timeout

timeout reply

timeout reply

timeout reply

timeout reply

Viewing MAC address conflicts on attached switches

If two HA clusters with the same virtual MAC address are connected to the same broadcast domain (L2 switch or
hub), the MAC address will conflict and bounce between the two clusters. This example Cisco switch MAC
address table shows the MAC address flapping between different interfaces (1/0/1 and 1/0/4).

1 0009.0f09.0002 DYNAMIC Gi1/0/1
1 0009.0f09.0002 DYNAMIC Gi1/0/4

Synchronizing the configuration
The FGCP uses a combination of incremental and periodic synchronization to make sure that the configuration of
all cluster units is synchronized to that of the primary unit.

The following settings are not synchronized between cluster units:
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l HA override.
l HA device priority.
l The virtual cluster priority.
l The FortiGate host name.
l The HA priority setting for a ping server (or dead gateway detection) configuration.
l The system interface settings of the HA reserved management interface.
l The HA default route for the reserved management interface, set using the ha-mgmt-interface-gateway

option of the config system ha command.

The primary unit synchronizes all other configuration settings, including the other HA configuration settings.

All synchronization activity takes place over the HA heartbeat link using TCP/703 and UDP/703 packets.

Disabling automatic configuration synchronization

In some cases you may want to use the following command to disable automatic synchronization of the primary
unit configuration to all cluster units.

config system ha
set sync-config disable

end

When this option is disabled the cluster no longer synchronizes configuration changes. If a device failure occurs,
the new primary unit may not have the same configuration as the failed primary unit. As a result, the new primary
unit may process sessions differently or may not function on the network in the same way.

In most cases you should not disable automatic configuration synchronization. However, if you have disabled this
feature you can use the execute ha synchronize command to manually synchronize a subordinate unit’s
configuration to that of the primary unit.

You must enter execute ha synchronize commands from the subordinate unit that you want to
synchronize with the primary unit. Use the execute ha manage command to access a subordinate unit CLI.

For example, to access the first subordinate unit and force a synchronization at any time, even if automatic
synchronization is disabled enter:

execute ha manage 0
execute ha synchronize start

You can use the following command to stop a synchronization that is in progress.

execute ha synchronize stop

Incremental synchronization

When you log into the cluster GUI or CLI to make configuration changes, you are actually logging into the primary
unit. All of your configuration changes are first made to the primary unit. Incremental synchronization then
immediately synchronizes these changes to all of the subordinate units.

When you log into a subordinate unit CLI (for example using execute ha manage) all of the configuration
changes that you make to the subordinate unit are also immediately synchronized to all cluster units, including
the primary unit, using the same process.

Incremental synchronization also synchronizes other dynamic configuration information such as the DHCP server
address lease database, routing table updates, IPsec SAs, MAC address tables, and so on. See FortiGate HA
compatibility with DHCP and PPPoE on page 1756 for more information about DHCP server address lease
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synchronization and Synchronizing kernel routing tables on page 1933 for information about routing table
updates.

Whenever a change is made to a cluster unit configuration, incremental synchronization sends the same
configuration change to all other cluster units over the HA heartbeat link. An HA synchronization process running
on the each cluster unit receives the configuration change and applies it to the cluster unit. The HA
synchronization process makes the configuration change by entering a CLI command that appears to be entered
by the administrator who made the configuration change in the first place.

Synchronization takes place silently, and no log messages are recorded about the synchronization activity.
However, log messages can be recorded by the cluster units when the synchronization process enters CLI
commands. You can see these log messages on the subordinate units if you enable event logging and set the
minimum severity level to Information and then check the event log messages written by the cluster units when
you make a configuration change.

You can also see these log messages on the primary unit if you make configuration changes from a subordinate
unit.

Periodic synchronization

Incremental synchronization makes sure that as an administrator makes configuration changes, the
configurations of all cluster units remain the same. However, a number of factors could cause one or more cluster
units to go out of sync with the primary unit. For example, if you add a new unit to a functioning cluster, the
configuration of this new unit will not match the configuration of the other cluster units. Its not practical to use
incremental synchronization to change the configuration of the new unit.

Periodic synchronization is a mechanism that looks for synchronization problems and fixes them. Every minute
the cluster compares the configuration file checksum of the primary unit with the configuration file checksums of
each of the subordinate units. If all subordinate unit checksums are the same as the primary unit checksum, all
cluster units are considered synchronized.

If one or more of the subordinate unit checksums is not the same as the primary unit checksum, the subordinate
unit configuration is considered out of sync with the primary unit. The checksum of the out of sync subordinate
unit is checked again every 15 seconds. This re-checking occurs in case the configurations are out of sync
because an incremental configuration sequence has not completed. If the checksums do not match after 5
checks the subordinate unit that is out of sync retrieves the configuration from the primary unit. The subordinate
unit then reloads its configuration and resumes operating as a subordinate unit with the same configuration as
the primary unit.

The configuration of the subordinate unit is reset in this way because when a subordinate unit configuration gets
out of sync with the primary unit configuration there is no efficient way to determine what the configuration
differences are and to correct them. Resetting the subordinate unit configuration becomes the most efficient way
to resynchronize the subordinate unit.

Synchronization requires that all cluster units run the same FortiOS firmware build. If some cluster units are
running different firmware builds, then unstable cluster operation may occur and the cluster units may not be able
to synchronize correctly.

Re-installing the firmware build running on the primary unit forces the primary unit to
upgrade all cluster units to the same firmware build.
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Console messages when configuration synchronization succeeds

When a cluster first forms, or when a new unit is added to a cluster as a subordinate unit, the following messages
appear on the CLI console to indicate that the unit joined the cluster and had its configuring synchronized with the
primary unit.

slave's configuration is not in sync with master's, sequence:0
slave's configuration is not in sync with master's, sequence:1

slave's configuration is not in sync with master's, sequence:2
slave's configuration is not in sync with master's, sequence:3
slave's configuration is not in sync with master's, sequence:4
slave starts to sync with master

logout all admin users
slave succeeded to sync with master

Console messages when configuration synchronization fails

If you connect to the console of a subordinate unit that is out of synchronization with the primary unit, messages
similar to the following are displayed.

slave is not in sync with master, sequence:0. (type 0x3)
slave is not in sync with master, sequence:1. (type 0x3)
slave is not in sync with master, sequence:2. (type 0x3)
slave is not in sync with master, sequence:3. (type 0x3)
slave is not in sync with master, sequence:4. (type 0x3)
global compared not matched

If synchronization problems occur the console message sequence may be repeated over and over again. The
messages all include a type value (in the example type 0x3). The type value can help Fortinet Support
diagnose the synchronization problem.

HA out of sync object messages and the configuration objects that they reference

Out of Sync Message Configuration Object

HA_SYNC_SETTING_CONFIGURATION = 0x03 /data/config

HA_SYNC_SETTING_AV = 0x10

HA_SYNC_SETTING_VIR_DB = 0x11 /etc/vir

HA_SYNC_SETTING_SHARED_LIB = 0x12 /data/lib/libav.so

HA_SYNC_SETTING_SCAN_UNIT = 0x13 /bin/scanunitd

HA_SYNC_SETTING_IMAP_PRXY = 0x14 /bin/imapd

HA_SYNC_SETTING_SMTP_PRXY = 0x15 /bin/smtp

HA_SYNC_SETTING_POP3_PRXY = 0x16 /bin/pop3

HA_SYNC_SETTING_HTTP_PRXY = 0x17 /bin/thttp

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

1928



HA and failover protection Chapter 15 - High Availability

Out of Sync Message Configuration Object

HA_SYNC_SETTING_FTP_PRXY = 0x18 /bin/ftpd

HA_SYNC_SETTING_FCNI = 0x19 /etc/fcni.dat

HA_SYNC_SETTING_FDNI = 0x1a /etc/fdnservers.dat

HA_SYNC_SETTING_FSCI = 0x1b /etc/sci.dat

HA_SYNC_SETTING_FSAE = 0x1c /etc/fsae_adgrp.cache

HA_SYNC_SETTING_IDS = 0x20 /etc/ids.rules

HA_SYNC_SETTING_IDSUSER_RULES = 0x21 /etc/idsuser.rules

HA_SYNC_SETTING_IDSCUSTOM = 0x22

HA_SYNC_SETTING_IDS_MONITOR = 0x23 /bin/ipsmonitor

HA_SYNC_SETTING_IDS_SENSOR = 0x24 /bin/ipsengine

HA_SYNC_SETTING_NIDS_LIB = 0x25 /data/lib/libips.so

HA_SYNC_SETTING_WEBLISTS = 0x30

HA_SYNC_SETTING_CONTENTFILTER = 0x31 /data/cmdb/webfilter.bword

HA_SYNC_SETTING_URLFILTER = 0x32 /data/cmdb/webfilter.urlfilter

HA_SYNC_SETTING_FTGD_OVRD = 0x33 /data/cmdb/webfilter.fgtd-ovrd

HA_SYNC_SETTING_FTGD_LRATING = 0x34 /data/cmdb/webfilter.fgtd-ovrd

HA_SYNC_SETTING_EMAILLISTS = 0x40

HA_SYNC_SETTING_EMAILCONTENT = 0x41 /data/cmdb/spamfilter.bword

HA_SYNC_SETTING_EMAILBWLIST = 0x42 /data/cmdb/spamfilter.emailbwl

HA_SYNC_SETTING_IPBWL = 0x43 /data/cmdb/spamfilter.ipbwl

HA_SYNC_SETTING_MHEADER = 0x44 /data/cmdb/spamfilter.mheader

HA_SYNC_SETTING_RBL = 0x45 /data/cmdb/spamfilter.rbl

HA_SYNC_SETTING_CERT_CONF = 0x50 /etc/cert/cert.conf

HA_SYNC_SETTING_CERT_CA = 0x51 /etc/cert/ca
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Out of Sync Message Configuration Object

HA_SYNC_SETTING_CERT_LOCAL = 0x52 /etc/cert/local

HA_SYNC_SETTING_CERT_CRL = 0x53 /etc/cert/crl

HA_SYNC_SETTING_DB_VER = 0x55

HA_GET_DETAIL_CSUM = 0x71

HA_SYNC_CC_SIG = 0x75 /etc/cc_sig.dat

HA_SYNC_CC_OP = 0x76 /etc/cc_op

HA_SYNC_CC_MAIN = 0x77 /etc/cc_main

HA_SYNC_FTGD_CAT_LIST = 0x7a /migadmin/webfilter/ublock/ftgd/
data/

Comparing checksums of cluster units

You can use the diagnose sys ha checksum show command to compare the configuration checksums of
all cluster units. The output of this command shows checksums labeled global and all as well as checksums
for each of the VDOMs including the root VDOM. The get system ha-nonsync-csum command can be
used to display similar information; however, this command is intended to be used by FortiManager.

The primary unit and subordinate unit checksums should be the same. If they are not you can use the execute
ha synchronize start command to force a synchronization.

The following command output is for the primary unit of a cluster that does not have multiple VDOMs enabled:

diagnose sys ha checksum show
is_manage_master()=1, is_root_master()=1
debugzone
global: a0 7f a7 ff ac 00 d5 b6 82 37 cc 13 3e 0b 9b 77
root: 43 72 47 68 7b da 81 17 c8 f5 10 dd fd 6b e9 57
all: c5 90 ed 22 24 3e 96 06 44 35 b6 63 7c 84 88 d5

checksum
global: a0 7f a7 ff ac 00 d5 b6 82 37 cc 13 3e 0b 9b 77
root: 43 72 47 68 7b da 81 17 c8 f5 10 dd fd 6b e9 57
all: c5 90 ed 22 24 3e 96 06 44 35 b6 63 7c 84 88 d5

The following command output is for a subordinate unit of the same cluster:

diagnose sys ha checksum show
is_manage_master()=0, is_root_master()=0
debugzone
global: a0 7f a7 ff ac 00 d5 b6 82 37 cc 13 3e 0b 9b 77
root: 43 72 47 68 7b da 81 17 c8 f5 10 dd fd 6b e9 57
all: c5 90 ed 22 24 3e 96 06 44 35 b6 63 7c 84 88 d5

checksum
global: a0 7f a7 ff ac 00 d5 b6 82 37 cc 13 3e 0b 9b 77
root: 43 72 47 68 7b da 81 17 c8 f5 10 dd fd 6b e9 57
all: c5 90 ed 22 24 3e 96 06 44 35 b6 63 7c 84 88 d5
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The following example shows using this command for the primary unit of a cluster with multiple VDOMs. Two
VDOMs have been added named test and Eng_vdm.

From the primary unit:

config global
diagnose sys ha checksum show
is_manage_master()=1, is_root_master()=1
debugzone
global: 65 75 88 97 2d 58 1b bf 38 d3 3d 52 5b 0e 30 a9
test: a5 16 34 8c 7a 46 d6 a4 1e 1f c8 64 ec 1b 53 fe
root: 3c 12 45 98 69 f2 d8 08 24 cf 02 ea 71 57 a7 01
Eng_vdm: 64 51 7c 58 97 79 b1 b3 b3 ed 5c ec cd 07 74 09
all: 30 68 77 82 a1 5d 13 99 d1 42 a3 2f 9f b9 15 53

checksum
global: 65 75 88 97 2d 58 1b bf 38 d3 3d 52 5b 0e 30 a9
test: a5 16 34 8c 7a 46 d6 a4 1e 1f c8 64 ec 1b 53 fe
root: 3c 12 45 98 69 f2 d8 08 24 cf 02 ea 71 57 a7 01
Eng_vdm: 64 51 7c 58 97 79 b1 b3 b3 ed 5c ec cd 07 74 09
all: 30 68 77 82 a1 5d 13 99 d1 42 a3 2f 9f b9 15 53

From the subordinate unit:

config global
diagnose sys ha checksum show
is_manage_master()=0, is_root_master()=0
debugzone
global: 65 75 88 97 2d 58 1b bf 38 d3 3d 52 5b 0e 30 a9
test: a5 16 34 8c 7a 46 d6 a4 1e 1f c8 64 ec 1b 53 fe
root: 3c 12 45 98 69 f2 d8 08 24 cf 02 ea 71 57 a7 01
Eng_vdm: 64 51 7c 58 97 79 b1 b3 b3 ed 5c ec cd 07 74 09
all: 30 68 77 82 a1 5d 13 99 d1 42 a3 2f 9f b9 15 53

checksum
global: 65 75 88 97 2d 58 1b bf 38 d3 3d 52 5b 0e 30 a9
test: a5 16 34 8c 7a 46 d6 a4 1e 1f c8 64 ec 1b 53 fe
root: 3c 12 45 98 69 f2 d8 08 24 cf 02 ea 71 57 a7 01
Eng_vdm: 64 51 7c 58 97 79 b1 b3 b3 ed 5c ec cd 07 74 09
all: 30 68 77 82 a1 5d 13 99 d1 42 a3 2f 9f b9 15 53

How to diagnose HA out of sync messages

This section describes how to use the diagnose sys ha checksum show and diagnose debug
commands to diagnose the cause of HA out of sync messages.

If HA synchronization is not successful, use the following procedures on each cluster unit to find the cause.

To determine why HA synchronization does not occur

1. Connect to each cluster unit CLI by connected to the console port.
2. Enter the following commands to enable debugging and display HA out of sync messages.

diagnose debug enable
diagnose debug console timestamp enable
diagnose debug application hatalk -1
diagnose debug application hasync -1

Collect the console output and compare the out of sync messages with the information in the table
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HA out of sync object messages and the configuration objects that they reference on page 1928.

3. Enter the following commands to turn off debugging.
diagnose debug disable
diagnose debug reset

To determine what part of the configuration is causing the problem

If the previous procedure displays messages that include sync object 0x30 (for example, HA_SYNC_SETTING_
CONFIGURATION = 0x03) there is a synchronization problem with the configuration. Use the following steps
to determine the part of the configuration that is causing the problem.

If your cluster consists of two cluster units, use this procedure to capture the configuration checksums for each
unit. If your cluster consists of more that two cluster units, repeat this procedure for all cluster units that returned
messages that include 0x30 sync object messages.

1. Connect to each cluster unit CLI by connected to the console port.
2. Enter the following command to turn on terminal capture

diagnose debug enable

3. Enter the following command to stop HA synchronization.
execute ha sync stop

4. Enter the following command to display configuration checksums.
diagnose sys ha checksum show global

5. Copy the output to a text file.
6. Repeat for all affected units.
7. Compare the text file from the primary unit with the text file from each cluster unit to find the checksums that do

not match.
You can use a diff function to compare text files.

8. Repeat for the root VDOM:
diagnose sys ha checksum show root

9. Repeat for all VDOMS (if multiple VDOM configuration is enabled):
diagnose sys ha checksum show <vdom-name>

10. You can also use the grep option to just display checksums for parts of the configuration.
For example to display system related configuration checksums in the root VDOM or log-related
checksums in the global configuration:

diagnose sys ha checksum root | grep system
diagnose sys ha chechsum global | grep log

Generally it is the first non-matching checksum that is the cause of the synchronization problem.

11. Attempt to remove/change the part of the configuration that is causing the problem. You can do this by making
configuration changes from the primary unit or subordinate unit CLI.

12. Enter the following commands to start HA configuration and stop debugging:
execute ha sync start
diagnose debug disable
diagnose debug reset
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Recalculating the checksums to resolve out of sync messages

Sometimes an error can occur when checksums are being calculated by the cluster. As a result of this calculation
error the CLI console could display out of sync error messages even though the cluster is otherwise operating
normally. You can also sometimes see checksum calculation errors in diagnose sys ha checksum
command output when the checksums listed in the debugzone output don’t match the checksums in the
checksum part of the output.

One solution to this problem could be to re-calculate the checksums. The re-calculated checksums should match
and the out of sync error messages should stop appearing.

You can use the following command to re-calculate HA checksums:

diagnose sys ha checksum recalculate [<vdom-name> | global]

Just entering the command without options recalculates all checksums. You can specify a VDOM name to just
recalculate the checksums for that VDOM. You can also enter global to recalculate the global checksum.

Synchronizing kernel routing tables
In a functioning cluster, the primary unit keeps all subordinate unit kernel routing tables (also called the
forwarding information base FIB) up to date and synchronized with the primary unit. All synchronization activity
takes place over the HA heartbeat link using TCP/703 and UDP/703 packets. After a failover, because of these
routing table updates the new primary unit does not have to populate its kernel routing table before being able to
route traffic. This gives the new primary unit time to rebuild its regular routing table after a failover.

Use the following command to view the regular routing table. This table contains all of the configured routes and
routes acquired from dynamic routing protocols and so on. This routing table is not synchronized. On subordinate
units this command will not produce the same output as on the primary unit.

get router info routing-table

Use the following command to view the kernel routing table (FIB). This is the list of resolved routes actually being
used by the FortiOS kernel. The output of this command should be the same on the primary unit and the
subordinate units.

get router info kernel

This section describes how clusters handle dynamic routing failover and also describes how to use CLI
commands to control the timing of routing table updates of the subordinate unit routing tables from the primary
unit.

Controlling how the FGCP synchronizes kernel routing table updates

You can use the following commands to control some of the timing settings that the FGCP uses when
synchronizing routing updates from the primary unit to subordinate units and maintaining routes on the primary
unit after a failover.

config system ha
set route-hold <hold_integer>
set route-ttl <ttl_integer>
set route-wait <wait_integer>

end

Change how long routes stay in a cluster unit routing table

Change the route-ttl time to control how long routes remain in a cluster unit routing table. The time to live
range is 5 to 3600 seconds. The default time to live is 10 seconds.
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The time to live controls how long routes remain active in a cluster unit routing table after the cluster unit
becomes a primary unit. To maintain communication sessions after a cluster unit becomes a primary unit, routes
remain active in the routing table for the route time to live while the new primary unit acquires new routes.

By default, route-ttl is set to 10 which may mean that only a few routes will remain in the routing table after a
failover. Normally keeping route-ttl to 10 or reducing the value to 5 is acceptable because acquiring new
routes usually occurs very quickly, especially if graceful restart is enabled, so only a minor delay is caused by
acquiring new routes.

If the primary unit needs to acquire a very large number of routes, or if for other reasons, there is a delay in
acquiring all routes, the primary unit may not be able to maintain all communication sessions.

You can increase the route time to live if you find that communication sessions are lost after a failover so that the
primary unit can use synchronized routes that are already in the routing table, instead of waiting to acquire new
routes.

Change the time between routing updates

Change the route-hold time to change the time that the primary unit waits between sending routing table
updates to subordinate units. The route hold range is 0 to 3600 seconds. The default route hold time is 10
seconds.

To avoid flooding routing table updates to subordinate units, set route-hold to a relatively long time to prevent
subsequent updates from occurring too quickly. Flooding routing table updates can affect cluster performance if a
great deal of routing information is synchronized between cluster units. Increasing the time between updates
means that this data exchange will not have to happen so often.

The route-hold time should be coordinated with the route-wait time.

Change the time the primary unit waits after receiving a routing update

Change the route-wait time to change how long the primary unit waits after receiving routing updates before
sending the updates to the subordinate units. For quick routing table updates to occur, set route-wait to a
relatively short time so that the primary unit does not hold routing table changes for too long before updating the
subordinate units.

The route-wait range is 0 to 3600 seconds. The default route-wait is 0 seconds.

Normally, because the route-wait time is 0 seconds the primary unit sends routing table updates to the
subordinate units every time its routing table changes.

Once a routing table update is sent, the primary unit waits the route-hold time before sending the next
update.

Usually routing table updates are periodic and sporadic. Subordinate units should receive these changes as soon
as possible so route-wait is set to 0 seconds. route-hold can be set to a relatively long time because
normally the next route update would not occur for a while.

In some cases, routing table updates can occur in bursts. A large burst of routing table updates can occur if a
router or a link on a network fails or changes. When a burst of routing table updates occurs, there is a potential
that the primary unit could flood the subordinate units with routing table updates. Flooding routing table updates
can affect cluster performance if a great deal of routing information is synchronized between cluster units. Setting
route-wait to a longer time reduces the frequency of additional updates are and prevents flooding of routing
table updates from occurring.
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Configuring graceful restart for dynamic routing failover
When an HA failover occurs, neighbor routers will detect that the cluster has failed and remove it from the
network until the routing topology stabilizes. During that time the routers may stop sending IP packets to the
cluster and communication sessions that would normally be processed by the cluster may time out or be dropped.
Also the new primary unit will not receive routing updates and so will not be able to build and maintain its routing
database.

You can solve this problem by configuring graceful restart for the dynamic routing protocols that you are using.
This section describes configuring graceful restart for OSPF and BGP.

To support graceful restart you should make sure the new primary unit keeps its synchronized routing data long
enough to acquire new routing data. You should also increase the HA route time to live, route wait, and route hold
values to 60 using the following CLI command:

config system ha
set route-ttl 60
set route-wait 60
set route-hold 60

end

Graceful OSPF restart

You can configure graceful restart (also called nonstop forwarding (NSF)) as described in RFC3623 (Graceful
OSPF Restart) to solve the problem of dynamic routing failover. If graceful restart is enabled on neighbor routers,
they will keep sending packets to the cluster following the HA failover instead of removing it from the network.
The neighboring routers assume that the cluster is experiencing a graceful restart.

After the failover, the new primary unit can continue to process communication sessions using the synchronized
routing data received from the failed primary unit before the failover. This gives the new primary unit time to
update its routing table after the failover.

You can use the following commands to enable graceful restart or NSF on Cisco routers:

router ospf 1
log-adjacency-changes
nsf ietf helper strict-lsa-checking

If the cluster is running OSPF, use the following command to enable graceful restart for OSPF:

config router ospf
set restart-mode graceful-restart

end

Graceful BGP restart

If the cluster is running BGP only the primary unit keeps BGP peering connections. When a failover occurs, the
BGP peering needs to be reestablished. This will happen if you enable BGP graceful restart which causes the
adjacent routers to keep the routes active while the BGP peering is restarted by the new primary unit.

Enabling BGP graceful restart causes the FortiGate's BGP process to restart which can
temporarily disrupt traffic through the cluster. So normally you should wait for a quiet
time or a maintenance period to enable BGP graceful restart.

Use the following command to enable graceful restart for BGP and set some graceful restart options.

config router bgp
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set graceful-restart enable
set graceful-restart-time 120
set graceful-stalepath-time 360
set graceful-update-delay 120

end

Notifying BGP neighbors when graceful restart is enabled

You can add BGP neighbors and configure the cluster unit to notify these neighbors that it supports graceful
restart.

config router bgp
config neighbor

edit <neighbor_address_Ipv4>
set capability-graceful-restart enable

end
end

Bidirectional Forwarding Detection (BFD) enabled BGP graceful restart

You can add a BFD enabled BGP neighbor as a static BFD neighbor using the following command. This example
shows how to add a BFD neighbor with IP address 172.20.121.23 that is on the network connected to port4:

config router bfd
config neighbor

edit 172.20.121.23
set port4

end
end

The FGCP supports graceful restart of BFD enabled BGP neighbors. The config router bfd command is
needed as the BGP auto-start timer is 5 seconds. After HA failover, BGP on the new primary unit has to wait for 5
seconds to connect to its neighbors, and then register BFD requests after establishing the connections. With
static BFD neighbors, BFD requests and sessions can be created as soon as possible after the failover. The new
command get router info bfd requests shows the BFD peer requests.

A BFD session created for a static BFD neighbor/peer request will initialize its state as "INIT" instead of "DOWN"
and its detection time asbfd-required-min-rx * bfd-detect-mult milliseconds.

When a BFD control packet with nonzero your_discr is received, if no session can be found to match the your_
discr, instead of discarding the packet, other fields in the packet, such as addressing information, are used to
choose one session that was just initialized, with zero as its remote discriminator.

When a BFD session in the up state receives a control packet with zero as your_discr and down as the state, the
session will change its state into down but will not notify this down event to BGP and/or other registered clients.

Link failover (port monitoring or interface monitoring)
Link failover means that if a monitored interface fails, the cluster reorganizes to reestablish a link to the network
that the monitored interface was connected to and to continue operating with minimal or no disruption of network
traffic.

You configure monitored interfaces (also called interface monitoring or port monitoring) by selecting the
interfaces to monitor as part of the cluster HA configuration.

You can monitor up to 64 interfaces.
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The interfaces that you can monitor appear on the port monitor list. You can monitor all FortiGate interfaces
including redundant interfaces and 802.3ad aggregate interfaces.

You cannot monitor the following types of interfaces (you cannot select the interfaces on the port monitor list):

l FortiGate interfaces that contain an internal switch.
l VLAN subinterfaces.
l IPsec VPN interfaces.
l Individual physical interfaces that have been added to a redundant or 802.3ad aggregate interface.
l FortiGate-5000 series backplane interfaces that have not been configured as network interfaces.

If you are configuring a virtual cluster you can create a different port monitor configuration for each virtual cluster.
Usually for each virtual cluster you would monitor the interfaces that have been added to the virtual domains in
each virtual cluster.

Wait until after the cluster is up and running to enable interface monitoring. You do not need
to configure interface monitoring to get a cluster up and running and interface monitoring
will cause failovers if for some reason during initial setup a monitored interface has become
disconnected. You can always enable interface monitoring once you have verified that the
cluster is connected and operating properly.

You should only monitor interfaces that are connected to networks, because a failover may
occur if you monitor an unconnected interface.

To enable interface monitoring - GUI

Use the following steps to monitor the port1 and port2 interfaces of a cluster.

1. Connect to the cluster GUI.
2. Go to System > HA and edit the primary unit (Role isMASTER).
3. Select the Port Monitor check boxes for the port1 and port2 interfaces and select OK.

The configuration change is synchronized to all cluster units.

To enable interface monitoring - CLI

Use the following steps to monitor the port1 and port2 interfaces of a cluster.

1. Connect to the cluster CLI.
2. Enter the following command to enable interface monitoring for port1 and port2.

configure system ha
set monitor port1 port2

end

The following example shows how to enable monitoring for the external, internal, and DMZ interfaces.

config system ha
set monitor external internal dmz

end

With interface monitoring enabled, during cluster operation, the cluster monitors each cluster unit to determine if
the monitored interfaces are operating and connected. Each cluster unit can detect a failure of its network
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interface hardware. Cluster units can also detect if its network interfaces are disconnected from the switch they
should be connected to.

Cluster units cannot determine if the switch that its interfaces are connected to is still
connected to the network. However, you can use remote IPmonitoring to make sure that
the cluster unit can connect to downstream network devices. See Remote link failover
(remote IPmonitoring) on page 1943.

Because the primary unit receives all traffic processed by the cluster, a cluster can only process traffic from a
network if the primary unit can connect to it. So, if the link between a network and the primary unit fails, to
maintain communication with this network, the cluster must select a different primary unit; one that is still
connected to the network. Unless another link failure has occurred, the new primary unit will have an active link to
the network and will be able to maintain communication with it.

To support link failover, each cluster unit stores link state information for all monitored cluster units in a link state
database. All cluster units keep this link state database up to date by sharing link state information with the other
cluster units. If one of the monitored interfaces on one of the cluster units becomes disconnected or fails, this
information is immediately shared with all cluster units.

If a monitored interface on the primary unit fails

If a monitored interface on the primary unit fails, the cluster renegotiates to select a new primary unit using the
process described in Primary unit selection on page 1744. Because the cluster unit with the failed monitored
interface has the lowest monitor priority, a different cluster unit becomes the primary unit. The new primary unit
should have fewer link failures.

After the failover, the cluster resumes and maintains communication sessions in the same way as for a device
failure. See Device failover on page 1910.

If a monitored interface on a subordinate unit fails

If a monitored interface on a subordinate unit fails, this information is shared with all cluster units. The cluster
does not renegotiate. The subordinate unit with the failed monitored interface continues to function in the cluster.

In an active-passive cluster after a subordinate unit link failover, the subordinate unit continues to function
normally as a subordinate unit in the cluster.

In an active-active cluster after a subordinate unit link failure:

l The subordinate unit with the failed monitored interface can continue processing connections between functioning
interfaces. However, the primary unit stops sending sessions to a subordinate unit that use any failed monitored
interfaces on the subordinate unit.

l If session pickup is enabled, all sessions being processed by the subordinate unit failed interface that can be failed
over are failed over to other cluster units. Sessions that cannot be failed over are lost and have to be restarted.

l If session pickup is not enabled all sessions being processed by the subordinate unit failed interface are lost.

How link failover maintains traffic flow

Monitoring an interface means that the interface is connected to a high priority network. As a high priority
network, the cluster should maintain traffic flow to and from the network, even if a link failure occurs. Because the
primary unit receives all traffic processed by the cluster, a cluster can only process traffic from a network if the
primary unit can connect to it. So, if the link that the primary unit has to a high priority network fails, to maintain
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traffic flow to and from this network, the cluster must select a different primary unit. This new primary unit should
have an active link to the high priority network.

A link failure causes a cluster to select a new primary unit

If a monitored interface on the primary unit fails, the cluster renegotiates and selects the cluster unit with the
highest monitor priority to become the new primary unit. The cluster unit with the highest monitor priority is the
cluster unit with the most monitored interfaces connected to networks.

After a link failover, the primary unit processes all traffic and all subordinate units, even the cluster unit with the
link failure, share session and link status. In addition all configuration changes, routes, and IPsec SAs are
synchronized to the cluster unit with the link failure.

In an active-active cluster, the primary unit load balances traffic to all the units in the cluster. The cluster unit with
the link failure can process connections between its functioning interfaces (for, example if the cluster has
connections to an internal, external, and DMZ network, the cluster unit with the link failure can still process
connections between the external and DMZ networks).

Recovery after a link failover and controlling primary unit selection (controlling falling back to
the prior primary unit)

If you find and correct the problem that caused a link failure (for example, re-connect a disconnected network
cable) the cluster updates its link state database and re-negotiates to select a primary unit.

What happens next depends on how the cluster configuration affects primary unit selection:

l The former primary unit will once again become the primary unit (falling back to becoming the primary unit)
l The primary unit will not change.

As described in Primary unit selection and age on page 1747, when the link is restored, if no options are
configured to control primary unit selection and the cluster age difference is less than 300 seconds the former
primary unit will once again become the primary unit. If the age differences are greater than 300 seconds then a
new primary unit is not selected. Since you have no control on the age difference the outcome can be
unpredictable. This is not a problem in cases where its not important which unit becomes the primary unit.
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Preventing a primary unit change after a failed link is restored

Some organizations will not want the cluster to change primary units when the link is restored. Instead they would
rather wait to restore the primary unit during a maintenance window. This functionality is not directly supported,
but you can experiment with changing some primary unit selection settings. For example, in most cases it should
work to enable override on all cluster units and make sure their priorities are the same. This should mean that the
primary unit should not change after a failed link is restored.

Then, when you want to restore the original primary unit during a maintenance window you can just set its Device
Priority higher. After it becomes the primary unit you can reset all device priorities to the same value. Alternatively
during a maintenance window you could reboot the current primary unit and any subordinate units except the one
that you want to become the primary unit.

If the override CLI keyword is enabled on one or more cluster units and the device priority of a cluster unit is
set higher than the others, when the link failure is repaired and the cluster unit with the highest device priority will
always become the primary unit.

Testing link failover

You can test link failure by disconnecting the network cable from a monitored interface of a cluster unit. If you
disconnect a cable from a primary unit monitored interface the cluster should renegotiate and select one of the
other cluster units as the primary unit. You can also verify that traffic received by the disconnected interface
continues to be processed by the cluster after the failover.

If you disconnect a cable from a subordinate unit interface the cluster will not renegotiate.

Updating MAC forwarding tables when a link failover occurs

When a FortiGate HA cluster is operating and a monitored interface fails on the primary unit, the primary unit
usually becomes a subordinate unit and another cluster unit becomes the primary unit. After a link failover, the
new primary unit sends gratuitous ARP packets to refresh the MAC forwarding tables (also called arp tables) of
the switches connected to the cluster. This is normal link failover operation.

Even when gratuitous ARP packets are sent, some switches may not be able to detect that the primary unit has
become a subordinate unit and will keep sending packets to the former primary unit. This can occur if the switch
does not detect the failure and does not clear its MAC forwarding table.

You have another option available to make sure the switch detects the failover and clears its MAC forwarding
tables. You can use the following command to cause a cluster unit with a monitored interface link failure to briefly
shut down all of its interfaces (except the heartbeat interfaces) after the failover occurs:

config system ha
set link-failed-signal enable

end

Usually this means each interface of the former primary unit is shut down for about a second. When this happens
the switch should be able to detect this failure and clear its MAC forwarding tables of the MAC addresses of the
former primary unit and pickup the MAC addresses of the new primary unit. Each interface will shut down for a
second but the entire process usually takes a few seconds. The more interfaces the FortiGate has, the longer it
will take.

Normally, the new primary unit also sends gratuitous ARP packets that also help the switch update its MAC
forwarding tables to connect to the new primary unit. If link-failed-signal is enabled, sending gratuitous
ARP packets is optional and can be disabled if you don’t need it or if its causing problems. See Disabling
gratuitous ARP packets after a failover on page 1920
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Multiple link failures

Every time a monitored interface fails, the cluster repeats the processes described above. If multiple monitored
interfaces fail on more than one cluster unit, the cluster continues to negotiate to select a primary unit that can
provide the most network connections.

Example link failover scenarios

For the following examples, assume a cluster configuration consisting of two FortiGates (FGT_1 and FGT_2)
connected to three networks: internal using port2, external using port1, and DMZ using port3. In the HA
configuration, the device priority of FGT_1 is set higher than the unit priority of FGT_2.

The cluster processes traffic flowing between the internal and external networks, between the internal and DMZ
networks, and between the external and DMZ networks. If there are no link failures, FGT1 becomes the primary
unit because it has the highest device priority.

Sample link failover scenario topology

Example the port1 link on FGT_1 fails

If the port1 link on FGT_1 fails, FGT_2 becomes primary unit because it has fewer interfaces with a link failure. If
the cluster is operating in active-active mode, the cluster load balances traffic between the internal network
(port2) and the DMZ network (port3). Traffic between the Internet (port1) and the internal network (port2) and
between the Internet (port1) and the DMZ network (port3) is processed by the primary unit only.

Example port2 on FGT_1 and port1 on FGT_2 fail

If port2 on FGT_1 and port1 on FGT_2 fail, then FGT_1 becomes the primary unit. After both of these link
failures, both cluster units have the same monitor priority. So the cluster unit with the highest device priority
(FGT_1) becomes the primary unit.
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Only traffic between the Internet (port1) and DMZ (port3) networks can pass through the cluster and the traffic is
handled by the primary unit only. No load balancing will occur if the cluster is operating in active-active mode.

Monitoring VLAN interfaces
If the FortiGates in the cluster have VLAN interfaces, you can use the following command to monitor all VLAN
interfaces and write a log message if one of the VLAN interfaces is found to be down.

Once configured, this feature works by verifying that the primary unit can connect to the subordinate unit over
each VLAN. This verifies that the switch that the VLAN interfaces are connected to is configured correctly for each
VLAN. If the primary unit cannot connect to the subordinate unit over one of the configured VLANs the primary
unit writes a link monitor log message indicating that the named VLAN went down (log message id 20099).

Use the following CLI command to enable monitoring VLAN interfaces:

config system ha-monitor
set monitor-vlan enable/disable
set vlan-hb-interval <interval_seconds>
set vlan-hb-lost-threshold <vlan-lost-heartbeat-threshold>

end

vlan-hb-interval is the time between sending VLAN heartbeat packets over the VLAN. The VLAN
heartbeat range is 1 to 30 seconds. The default is 5 seconds.

vlan-hb-lost-threshold is the number of consecutive VLAN heartbeat packets that are not successfully
received across the VLAN before assuming that the VLAN is down. The default value is 3, meaning that if 3
heartbeat packets sent over the VLAN are not received then the VLAN is considered to be down. The range is 1 to
60 packets.

A VLAN heartbeat interval of 5 means the time between heartbeat packets is five seconds. A VLAN heartbeat
threshold of 3 means it takes 5 x 3 = 15 seconds to detect that a VLAN is down.

Sub-second failover
On FortiGate models 395xB and 3x40B HA link failover supports sub-second failover (that is a failover time of less
than one second). Sub-second failover is available for interfaces that can issue a link failure system call when the
interface goes down. When an interface experiences a link failure and sends the link failure system call, the
FGCP receives the system call and initiates a link failover.

For interfaces that do not support sub-second failover, port monitoring regularly polls the connection status of
monitored interfaces. When a check finds that an interface has gone down, port monitoring causes a link failover.
Sub-second failover results in a link failure being detected sooner because the system doesn’t have to wait for the
next poll to find out about the failure.

Sub-second failover can accelerate HA failover to reduce the link failover time to less than one second under ideal
conditions. Actual failover performance may be vary depending on traffic patterns and network configuration. For
example, some network devices may respond slowly to an HA failover.

No configuration changes are required to support sub-second failover. However, for best sub-second failover
results, the recommended heartbeat interval is 100ms and the recommended lost heartbeat threshold is 5 (see
Modifying heartbeat timing on page 1916).

config system ha
set hb-lost-threshold 5
set hb-interval 1

end
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For information about how to reduce failover times, see Failover performance on page 1951.

Remote link failover (remote IP monitoring)
Remote link failover uses link health monitors on the primary FortiGate to test connectivity with IP addresses of
remote network devices, for example, a downstream router. Remote link failover causes a failover if one or more
of these remote IP addresses does not respond to link health checking.

By being able to detect failures in network equipment not directly connected to the cluster, remote link failover
can be useful in a number of ways depending on your network configuration. For example, in a full mesh HA
configuration, with remote IPmonitoring, the cluster can detect failures in network equipment that is not directly
connected to the cluster but that would interrupt traffic processed by the cluster if the equipment failed.

Example HA remote IP monitoring topology

In the simplified example topology shown above, the switch connected directly to the primary unit is operating
normally but the link on the other side of the switch fails. After the failure, traffic can no longer flow between the
primary unit and the internet.

To detect this failure you can enable remote link failover and create a link health monitor for port2 that causes the
primary unit to test connectivity to 192.168.20.20. If the link health monitor can't connect to 192.268.20.20, the
cluster to fails over and the subordinate unit becomes the new primary unit. After the failover, the health check
monitor on the new primary unit can connect to 192.168.20.20, so the failover maintains connectivity between
the internal network and the internet through the cluster.
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Remote link failover is active only on the primary unit and only the primary unit can detect a remote link failure. If
the primary unit detects a remote link failure and causes a failover, the new primary unit may also detect this
failure and cause another failover.

To reduce the potential number of failovers, remote IPmonitoring includes a flip timer, set to a relatively high
default value of 60 minutes. The flip timeout stops HA remote link failover from causing a failover until the
primary unit has been operating for the duration of the flip timeout.

If you set the flip timeout to a relatively high number of minutes, you can find and repair the network problem that
prevented the cluster from connecting to the remote IP address without the cluster experiencing very many
failovers. Even if it takes a while to detect the problem, repeated failovers at relatively long time intervals do not
usually disrupt network traffic.

Example remote link failover configuration

In most cases you should accept the default remote link failover configuration. The default configuration consists
of:

l Enabling HA remote link failover for one or more FortiGate interfaces.
l Enabling link monitoring for those interfaces.

For example, the following configuration enables HA remote IPmonitoring for the port2 interface:

config system ha
set pingserver-monitor-interface port2
set pingserver-failover-threshold 0
set pingserver-slave-force-reset enable
set pingserver-flip-timeout 60

end

The pingserver-failover-threshold, pingserver-slave-force-reset, and pingserver-
flip-timeout options remain set to their default values.

After enabling HA remote link failover, you must configure a link monitor for the interface. The link monitor also
includes the remote IP address to monitor. All other options, including the ha-priority remain set to defaults:

config system link-monitor
edit ha-link-monitor

set server 192.168.20.20
set srcintf port2
set ha-priority 1
set interval 1
set failtime 5

end

This configuration causes the primary unit to check the 192.168.20.20 IP address from the port2 interface and to
cause a failover if the link monitor doesn't get a response from this IP address after 5 failed attempts. After a
failover occurs, HA remote link failover can't cause another failover for at least 60 minutes. After 60 minutes, the
cluster uses the normal primary unit selection process to select a primary unit. After the new primary unit is
selected, link monitoring resumes operating as before.

You can adjust this configuration in following ways:

l Enabling remote link failover for more interfaces by adding more interfaces to the pingserver-monitor-
interface. You must also add a link monitor for each interface.

l If you have enabled override, you can disable pingserver-slave-force-reset to reduce the number of
failovers. If override is enabled and a remote link failover has occured, after the flip timeout, even if the current
primary unit is not experiencing a remote link failure, if pingserver-slave-force-reset is enabled, override
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causes the cluster to negotiate and select the FortiGate with the highest priority to become the primary unit. Then,
if the remote link has not been restored for the FortiGate with the highest priority, remote link failover may cause
another failover. But with override enabled, if pingsever-slave-force-reset is disabled, as long as the
current primary unit is not experiencing a remote link failure, the cluster will not renegotiate. In brief, disabling
pingserver-slave-force-reset prevents repeated failovers if the remote link is not restored for both
FortiGates when the current primary unit experiences a remote link failure.

l Increase the interval or failtime to reduce how often a remote link failure is detected.

Changing the link monitor failover threshold

If you have multiple link monitors, you may want a failover to occur only if more than one of them fails.

For example, you may have three link monitors configured on three interfaces but only want a failover to occur if
two of the link monitors fail. To do this you must set the HA priorities of the link monitors and the HA
pingserver-failover-threshold so that the priority of one link monitor is less than the failover threshold
but the added priorities of two link monitors is equal to or greater than the failover threshold. Failover occurs when
the HA priority of all failed link monitors reaches or exceeds the threshold.

For example, set the failover threshold to 10 and monitor three interfaces:

config system ha
set pingserver-monitor-interface port2 port20 vlan_234
set pingserver-failover-threshold 10
set pingserver-flip-timeout 120

end

Then set the HA priority of link monitor server to 5.

The HA Priority (ha-priority) setting is not synchronized among cluster units. In the
following example, you must set the HA priority to 5 by logging into each cluster unit unless
you only want this configuration to be active on one of the units in the cluster.

config system link-monitor
edit port2

set srcintf port2
set server 192.168.20.20
set ha-priority 5

next
edit port20

set srcintf port20
set server 192.168.20.30
set ha-priority 5

next
edit vlan_234

set srcintf vlan_234
set server 172.20.12.10
set ha-priority 5

end

If only one of the link monitors fails, the total link monitor HA priority will be 5, which is lower than the failover
threshold so a failover will not occur. If a second link monitor fails, the total link monitor HA priority of 10 will equal
the failover threshold, causing a failover.

By adding multiple link monitors and setting the HA priorities for each, you can fine tune remote IPmonitoring.
For example, if it is more important to maintain connections to some networks you can set the HA priorities higher
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for these link monitors. And if it is less important to maintain connections to other networks you can set the HA
priorities lower for these link monitors. You can also adjust the failover threshold so that if the cluster cannot
connect to one or two high priority IP addresses a failover occurs. But a failover will not occur if the cluster cannot
connect to one or two low priority IP addresses.

Detecting HA remote IP failover events

Just as with any HA failover, you can detect HA remote link faiolver events using SNMP to monitor for HA traps.
You can also use alert email to receive notifications of HA status changes and monitor log messages for HA
failover log messages. In addition, the critical log message Ping Server is down is generated when a ping
server fails. The log message includes the name of the interface that the ping server that detected the failure.

Failover and attached network equipment
It normally takes a cluster approximately 6 seconds to complete a failover. However, the actual failover time
experienced by your network users may depend on how quickly the switches connected to the cluster interfaces
accept the cluster MAC address update from the primary unit. If the switches do not recognize and accept the
gratuitous ARP packets and update their MAC forwarding table, the failover time will increase.

Also, individual session failover depends on whether the cluster is operating in active-active or active-passive
mode, and whether the content of the traffic is to be virus scanned. Depending on application behavior, it may
take a TCP session a longer period of time (up to 30 seconds) to recover completely.

Monitoring cluster units for failover
You can use logging and SNMP to monitor cluster units for failover. Both the primary and subordinate units can
be configured to write log messages and send SNMP traps if a failover occurs. You can also log into the cluster
GUI and CLI to determine if a failover has occurred.

NAT mode active-passive cluster packet flow
This section describes how packets are processed and how failover occurs in an active-passive HA cluster running
in NAT mode. In the example, the NAT mode cluster acts as the internet firewall for a client computer’s internal
network. The client computer’s default route points at the IP address of the cluster internal interface. The client
connects to a web server on the Internet. Internet routing routes packets from the cluster external interface to the
web server, and from the web server to the cluster external interface.

In an active-passive cluster operating in NAT mode, four MAC addresses are involved in communication between
the client and the web server when the primary unit processes the connection:

l Internal virtual MAC address (MAC_V_int) assigned to the primary unit internal interface,
l External virtual MAC address (MAC_V_ext) assigned to the primary unit external interface,
l Client MAC address (MAC_Client),
l Server MAC address (MAC_Server),

In NAT mode, the HA cluster works as a gateway when it responds to ARP requests. Therefore, the client and
server only know the gateway MAC addresses. The client only knows the cluster internal virtual MAC address
(MAC_V_int) and the server only know the cluster external virtual MAC address (MAC_V_int).
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NAT mode active-passive packet flow

Packet flow from client to web server

1. The client computer requests a connection from 10.11.101.10 to 172.20.120.130.
2. The default route on the client computer recognizes 10.11.101.100 (the cluster IP address) as the gateway to the

external network where the web server is located.
3. The client computer issues an ARP request to 10.11.101.100.
4. The primary unit intercepts the ARP request, and responds with the internal virtual MAC address (MAC_V_int)

which corresponds to its IP address of 10.11.101.100.
5. The client’s request packet reaches the primary unit internal interface.

IP address MAC address

Source 10.11.101.10 MAC_Client

Destination 172.20.120.130 MAC_V_int

6. The primary unit processes the packet.
7. The primary unit forwards the packet from its external interface to the web server.

IP address MAC address

Source 172.20.120.141 MAC_V_ext

Destination 172.20.120.130 MAC_Server

8. The primary unit continues to process packets in this way unless a failover occurs.
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Packet flow from web server to client

1. When the web server responds to the client’s packet, the cluster external interface IP address (172.20.120.141) is
recognized as the gateway to the internal network.

2. The web server issues an ARP request to 172.20.120.141.
3. The primary unit intercepts the ARP request, and responds with the external virtual MAC address (MAC_V_ext)

which corresponds its IP address of 172.20.120.141.
4. The web server then sends response packets to the primary unit external interface.

IP address MAC address

Source 172.20.120.130 MAC_Server

Destination 172.20.120.141 MAC_V_ext

5. The primary unit processes the packet.
6. The primary unit forwards the packet from its internal interface to the client.

IP address MAC address

Source 172.20.120.130 MAC_V_int

Destination 10.11.101.10 MAC_Client

7. The primary unit continues to process packets in this way unless a failover occurs.

When a failover occurs

The following steps are followed after a device or link failure of the primary unit causes a failover.

1. If the primary unit fails the subordinate unit becomes the primary unit.
2. The new primary unit changes the MAC addresses of all of its interfaces to the HA virtual MAC addresses.

The new primary unit has the same IP addresses and MAC addresses as the failed primary unit.

3. The new primary units sends gratuitous ARP packets from the internal interface to the 10.11.101.0 network to
associate its internal IP address with the internal virtual MAC address.

4. The new primary units sends gratuitous ARP packets to the 172.20.120.0 to associate its external IP address with
the external virtual MAC address.

5. Traffic sent to the cluster is now received and processed by the new primary unit.
If there were more than two cluster units in the original cluster, these remaining units would become
subordinate units.

Transparent mode active-passive cluster packet flow
This section describes how packets are processed and how failover occurs in an active-passive HA cluster running
in transparent mode. The cluster is installed on an internal network in front of a mail server and the client
connects to the mail server through the transparent mode cluster.

In an active-passive cluster operating in transparent mode, two MAC addresses are involved in the
communication between a client and a server when the primary unit processes a connection:
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l Client MAC address (MAC_Client)
l Server MAC address (MAC_Server)

The HA virtual MAC addresses are not directly involved in communication between the client and the server. The
client computer sends packets to the mail server and the mail server sends responses. In both cases the packets
are intercepted and processed by the cluster.

The cluster’s presence on the network is transparent to the client and server computers. The primary unit sends
gratuitous ARP packets to Switch 1 that associate all MAC addresses on the network segment connected to the
cluster external interface with the HA virtual MAC address. The primary unit also sends gratuitous ARP packets to
Switch 2 that associate all MAC addresses on the network segment connected to the cluster internal interface
with the HA virtual MAC address. In both cases, this results in the switches sending packets to the primary unit
interfaces.

Transparent mode active-passive packet flow

Packet flow from client to mail server

1. The client computer requests a connection from 10.11.101.10 to 110.11.101.200.
2. The client computer issues an ARP request to 10.11.101.200.
3. The primary unit forwards the ARP request to the mail server.
4. The mail server responds with its MAC address (MAC_Server) which corresponds to its IP address of

10.11.101.200. The primary unit returns the ARP response to the client computer.
5. The client’s request packet reaches the primary unit internal interface.

IP address MAC address

Source 10.11.101.10 MAC_Client

Destination 10.11.101.200 MAC_Server
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6. The primary unit processes the packet.
7. The primary unit forwards the packet from its external interface to the mail server.

IP address MAC address

Source 10.11.101.10 MAC_Client

Destination 10.11.101.200 MAC_Server

8. The primary unit continues to process packets in this way unless a failover occurs.

Packet flow from mail server to client

1. To respond to the client computer, the mail server issues an ARP request to 10.11.101.10.
2. The primary unit forwards the ARP request to the client computer.
3. The client computer responds with its MAC address (MAC_Client) which corresponds to its IP address of

10.11.101.10. The primary unit returns the ARP response to the mail server.
4. The mail server’s response packet reaches the primary unit external interface.

IP address MAC address

Source 10.11.101.200 MAC_Server

Destination 10.11.101.10 MAC_Client

5. The primary unit processes the packet.
6. The primary unit forwards the packet from its internal interface to the client.

IP address MAC address

Source 10.11.101.200 MAC_Server

Destination 10.11.101.10 MAC_Client

7. The primary unit continues to process packets in this way unless a failover occurs.

When a failover occurs

The following steps are followed after a device or link failure of the primary unit causes a failover.

1. If the primary unit fails, the subordinate unit negotiates to become the primary unit.
2. The new primary unit changes the MAC addresses of all of its interfaces to the HA virtual MAC address.
3. The new primary units sends gratuitous ARP packets to switch 1 to associate its MAC address with the MAC

addresses on the network segment connected to the external interface.
4. The new primary units sends gratuitous ARP packets to switch 2 to associate its MAC address with the MAC

addresses on the network segment connected to the internal interface.
5. Traffic sent to the cluster is now received and processed by the new primary unit.

If there were more than two cluster units in the original cluster, these remaining units would become
subordinate units.
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Failover performance
This section describes the designed device and link failover times for a FortiGate cluster and also shows results of
a failover performance test.

Device failover performance

By design FGCP device failover time is 2 seconds for a two-member cluster with ideal network and traffic
conditions. If sub-second failover is enabled the failover time can drop below 1 second.

All cluster units regularly receive HA heartbeat packets from all other cluster units over the HA heartbeat link. If
any cluster unit does not receive a heartbeat packet from any other cluster unit for 2 seconds, the cluster unit that
has not sent heartbeat packets is considered to have failed.

It may take another few seconds for the cluster to negotiate and re-distribute communication sessions. Typically
if sub-second failover is not enabled you can expect a failover time of 9 to 15 seconds depending on the cluster
and network configuration. The failover time can also be increased by more complex configurations and or
configurations with network equipment that is slow to respond.

You can change the hb-lost-threshold to increase or decrease the device failover time. See Modifying
heartbeat timing on page 1916 for information about using hb-lost-threshold, and other heartbeat timing
settings.

Link failover performance

Link failover time is controlled by how long it takes for a cluster to synchronize the cluster link database. When a
link failure occurs, the cluster unit that experienced the link failure uses HA heartbeat packets to broadcast the
updated link database to all cluster units. When all cluster units have received the updated database the failover
is complete.

It may take another few seconds for the cluster to negotiate and re-distribute communication sessions.

Reducing failover times

l Keep the network configuration as simple as possible with as few as possible network connections to the cluster.
l If possible operate the cluster in transparent mode.
l Use high-performance switches to that the switches failover to interfaces connected to the new primary unit as

quickly as possible.
l Use accelerated FortiGate interfaces. In some cases accelerated interfaces will reduce failover times.
l Make sure the FortiGate sends multiple gratuitous arp packets after a failover. In some cases, sending more

gratuitous arp packets will cause connected network equipment to recognize the failover sooner. To send 10
gratuitous arp packets:

config system ha
set arps 10

end

l Reduce the time between gratuitous arp packets. This may also caused connected network equipment to recognize
the failover sooner. To send 50 gratuitous arp packets with 1 second between each packet:

config system ha
set arps 50
set arps-interval 1

end
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l Reduce the number of lost heartbeat packets and reduce the heartbeat interval timers to be able to more quickly
detect a device failure. To set the lost heartbeat threshold to 3 packets and the heartbeat interval to 100
milliseconds:

config system ha
set hb-interval 1
set hb-lost-threshold 3

end

l Reduce the hello state hold down time to reduce the amount of the time the cluster waits before transitioning from
the hello to the work state. To set the hello state hold down time to 5 seconds:

config system ha
set hello-holddown 5

end

l Enable sending a link failed signal after a link failover to make sure that attached network equipment responds a
quickly as possible to a link failure. To enable the link failed signal:

config system ha
set link-failed-signal enable

end
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Session failover means that after the primary unit fails, communications sessions resume on the new primary unit
with minimal or no interruption. Two categories of sessions need to be resumed after a failover:

l Sessions passing through the cluster
l Sessions terminated by the cluster

If you enable session failover (also called session-pickup) for the cluster, during cluster operation the primary unit
informs the subordinate units of changes to the primary unit connection and state tables for sessions passing
through the cluster, keeping the subordinate units up-to-date with the traffic currently being processed by the
cluster. All synchronization activity takes place over the HA heartbeat link using TCP/703 and UDP/703 packets.

After a failover the new primary unit recognizes open sessions that were being handled by the cluster. The
sessions continue to be processed by the new primary unit and are handled according to their last known state.

Session-pickup has some limitations. For example, session failover is not supported
for sessions being scanned by proxy-based security profiles. Session failover is
supported for sessions being scanned by flow-based security profiles; however, flow-
based sessions that fail over are not inspected after they fail over. For more
limitations, see Session failover limitations for sessions passing through the cluster on
page 1955.

Session terminated by the cluster include management sessions (such as HTTPS connections to the FortiGate
GUI or SSH connection to the CLI as well as SNMP and logging and so on). Also included in this category are
IPsec VPN, SSL VPN, sessions terminated by the cluster, explicit proxy, WAN Optimization and web caching. In
general, whether or not session-pickup is enabled, these sessions do not failover and have to be restarted. There
are some exceptions though, particularly for IPsec and SSL VPN. For more information, see Session failover
limitations for sessions terminated by the cluster on page 1958.

Enabling session-pickup for TCP, UDP, ICMP, and multicast session failover
To enable session-pickup, go to System > HA and enable session-pickup.

From the CLI enter:

config system ha
set session-pickup enable

end

When session-pickup is enabled, the FGCP synchronizes the primary unit's TCP session table to all cluster units.
As soon as a new TCP session is added to the primary unit session table, that session is synchronized to all
cluster units. This synchronization happens as quickly as possible to keep the session tables synchronized.

If the primary unit fails, the new primary unit uses its synchronized session table to resume all TCP sessions that
were being processed by the former primary unit with only minimal interruption. Under ideal conditions all TCP
sessions should be resumed. This is not guaranteed though and under less than ideal conditions some TCP
sessions may need to be restarted.

Enabling UDP and ICMP session failover

If session pickup is enabled, you can use the following command to also enable UDP and ICMP session failover:

1953 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 15 - High Availability Session failover (session-pickup)

config system ha
set session-pickup-connectionless enable

end

Enabling multicast session failover

To configure multicast session failover, use the following command to change the multicast TTL timer to a
smaller value than the default. The recommended setting to support multicast session failover is 120 seconds (2
minutes). The default setting is 600 seconds (10 minutes).

config system ha
set multicast-ttl 120

end

The multicast TTL timer controls how long to keep synchronized multicast routes on the backup unit (so they are
present on the backup unit when it becomes the new primary unit after a failover). If you set the multicast TTL
lower the multicast routes on the backup unit are refreshed more often so are more likely to be accurate.
Reducing this time causes route synchronization to happen more often and could affect performance.

If session pickup is disabled
If you leave session pickup disabled, the cluster does not keep track of sessions and after a failover, active
sessions have to be restarted or resumed. Most session can be resumed as a normal result of how TCP/IP
communications resumes communication after any routine network interruption.

The session-pickup setting does not affect session failover for sessions terminated by
the cluster.

If you do not require session failover protection, leaving session pickup disabled may reduce CPU usage and
reduce HA heartbeat network bandwidth usage. Also if your cluster is mainly being used for traffic that is not
synchronized (for example, for proxy-based security profile processing) enabling session pickup is not
recommended since most sessions will not be failed over anyway.

If session pickup is not enabled, the FGCP does not synchronize the primary unit session table to other cluster
units and sessions do not resume after a failover. After a device or link failover all sessions are briefly interrupted
and must be re-established at the application level after the cluster renegotiates.

Many protocols can successfully restart sessions with little, if any, loss of data. For example, after a failover,
users browsing the web can just refresh their browsers to resume browsing. Since most HTTP sessions are very
short, in most cases they will not even notice an interruption unless they are downloading large files. Users
downloading a large file may have to restart their download after a failover.

Other protocols may experience data loss and some protocols may require sessions to be manually restarted. For
example, a user downloading files with FTPmay have to either restart downloads or restart their FTP client.

Improving session synchronization performance
Two HA configuration options are available to reduce the performance impact of enabling session-pickup. They
include reducing the number of sessions that are synchronized by adding a session pickup delay and using more
FortiGate interfaces for session synchronization.
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Reducing the number of sessions that are synchronized

If session pickup is enabled, as soon as new sessions are added to the primary unit session table they are
synchronized to the other cluster units. Enable the session-pickup-delay CLI option to reduce the number
of sessions that are synchronized by synchronizing sessions only if they remain active for more than 30 seconds.
Enabling this option could greatly reduce the number of sessions that are synchronized if a cluster typically
processes very many short duration sessions, which is typical of most HTTP traffic for example.

Use the following command to enable a 30 second session pickup delay:

config system ha
set session-pickup-delay enable

end

Enabling session pickup delay means that if a failover occurs more sessions may not be resumed after a failover.
In most cases short duration sessions can be restarted with only a minor traffic interruption. However, if you
notice too many sessions not resuming after a failover you might want to disable this setting.

Using multiple FortiGate interfaces for session synchronization

Using the session-sync-dev option you can select one or more FortiGate interfaces to use for synchronizing
sessions as required for session pickup. Normally session synchronization occurs over the HA heartbeat link.
Using this HA option means only the selected interfaces are used for session synchronization and not the HA
heartbeat link. If you select more than one interface, session synchronization traffic is load balanced among the
selected interfaces.

Moving session synchronization from the HA heartbeat interface reduces the bandwidth required for HA heartbeat
traffic and may improve the efficiency and performance of the cluster, especially if the cluster is synchronizing a
large number of sessions. Load balancing session synchronization among multiple interfaces can further improve
performance and efficiency if the cluster is synchronizing a large number of sessions.

Use the following command to perform cluster session synchronization using the port10 and port12 interfaces.

config system ha
set session-sync-dev port10 port12

end

Session synchronization packets use Ethertype 0x8892. The interfaces to use for session synchronization must
be connected together either directly using the appropriate cable (possible if there are only two units in the
cluster) or using switches. If one of the interfaces becomes disconnected the cluster uses the remaining
interfaces for session synchronization. If all of the session synchronization interfaces become disconnected,
session synchronization reverts back to using the HA heartbeat link. All session synchronization traffic is between
the primary unit and each subordinate unit.

Since large amounts of session synchronization traffic can increase network congestion, it is recommended that
you keep this traffic off of your network by using dedicated connections for it.

Session failover limitations for sessions passing through the cluster
This section contains information about session failover for communication sessions passing through the cluster.
In general, if session pickup is enabled, session failover is supported for most TCP traffic. This section describes
details about how this all works.
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Protocol Session Failover?

Most TCP
sessions.

Supported if session-pickup is enabled. (More about TCP session failover on page 1956)

Multicast
sessions Supported if multicast session-pickup is enabled. (Enabling multicast session failover).

IPv6,
NAT64, and
NAT66

Supported if session-pickup is enabled.

Proxy-based
security
profile
sessions

Not Supported, sessions have to be restarted. Proxy-based features require the FortiGate to
maintain very large amounts of internal state information for each session. The FGCP does not
synchronize this internal state information. As a result, proxy-based sessions are not failed over.
Active-active clusters can resume some of these sessions after a failover. (Active-active HA
subordinate units sessions can resume after a failover on page 1958)

Flow-based
security
profile
sessions.

Supported if session-pickup is enabled. Flow-based sessions failover, but internal state information
is not synchronized so sessions that fail over are no longer inspected by security profile functions.

If both flow-based and proxy-based security profile features are applied to a TCP session, that
session will not resume after a failover.

UDP and
ICMP, or
broadcast
sessions

Supported if connectionless session-pickup is enabled. Otherwise, sessions have to be restarted.
(UDP, ICMP, and broadcast packet session failover on page 1957)

GPRS
Tunneling
Protocol
(GTP)

Supported with limitations. (FortiOS Carrier GTP session failover on page 1958)

SIP Supported for active-passive HA only. (SIP session failover on page 1957)

SIMPLE, or
SCCP signal
session

Not supported, sessions have to be restarted.

SSL
offloading
and HTTP
multiplexing

Not supported, sessions have to be restarted. (SSL offloading and HTTPmultiplexing session
failover on page 1958)

More about TCP session failover

TCP sessions that are not being processed by security profile features resume after a failover even if these
sessions are accepted by security policies with security profiles. Only TCP sessions that are actually being
processed by these security profile features do not resume after a failover. For example:
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l TCP sessions that are not virus scanned, web filtered, spam filtered, content archived, or are not SIP, SIMPLE, or
SCCP signal traffic resume after a failover, even if they are accepted by a security policy with security profile options
enabled. For example, SNMP TCP sessions through the FortiGate resume after a failover because FortiOS does
not apply any security profile options to SNMP sessions.

l TCP sessions for a protocol for which security profile features have not been enabled resume after a failover even if
they are accepted by a security policy with security profile features enabled. For example, if you have not enabled
any antivirus or content archiving settings for FTP, FTP sessions resume after a failover.

UDP, ICMP, and broadcast packet session failover

By default, even with session pickup enabled, the FGCP does not maintain a session table for UDP, ICMP, or
broadcast packets. So the cluster does not specifically support failover of these packets.

Some UDP traffic can continue to flow through the cluster after a failover. This can happen if, after the failover, a
UDP packet that is part of an already established communication stream matches a security policy. Then a new
session will be created and traffic will flow. So after a short interruption, UDP sessions can appear to have failed
over. However, this may not be reliable for the following reasons:

l UDP packets in the direction of the security policy must be received before reply packets can be accepted. For
example, if a port1 -> port2 policy accepts UDP packets, UDP packets received at port2 destined for the network
connected to port1 will not be accepted until the policy accepts UDP packets at port1 that are destined for the
network connected to port2. So, if a user connects from an internal network to the Internet and starts receiving UDP
packets from the Internet (for example streaming media), after a failover the user will not receive any more UDP
packets until the user re-connects to the Internet site.

l UDP sessions accepted by NAT policies will not resume after a failover because NAT will usually give the new
session a different source port. So only traffic for UDP protocols that can handle the source port changing during a
session will continue to flow.

You can however, enable session pickup for UDP and ICMP packets by enabling session pickup for TCP sessions
and then enabling session pickup for connectionless sessions:

config system ha
set session-pickup enable
set session-pickup-connectionless enable

end

This configuration causes the cluster units to synchronize UDP and ICMP session tables and if a failover occurs
UDP and ICMP sessions are maintained.

SIP session failover

If session pickup is enabled, the FGCP supports SIP session failover (also called stateful failover) for
active-passive HA.

SIP session failover replicates SIP states to all cluster units. If an HA failover occurs, all in-progress SIP calls
(setup complete) and their RTP flows are maintained and the calls will continue after the failover with minimal or
no interruption.

SIP calls being set up at the time of a failover may lose signaling messages. In most cases the SIP clients and
servers should use message retransmission to complete the call setup after the failover has completed. As a
result, SIP users may experience a delay if their calls are being set up when an HA a failover occurs. But in most
cases the call setup should be able to continue after the failover.
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FortiOS Carrier GTP session failover

FortiOS Carrier HA supports GTP session failover. The primary unit synchronizes the GTP tunnel state to all
cluster units after the GTP tunnel setup is completed. After the tunnel setup is completed, GTP sessions use
UDP and HA does not synchronize UDP sessions to all cluster units. However, similar to other UDP sessions,
after a failover, since the new primary unit will have the GTP tunnel state information, GTPUDP sessions using
the same tunnel can continue to flow with some limitations.

The limitation on packets continuing to flow is that there has to be a security policy to accept the packets. For
example, if the FortiOS Carrier unit has an internal to external security policy, GTPUDP sessions using an
established tunnel that are received by the internal interface are accepted by the security policy and can continue
to flow. However, GTPUDP packets for an established tunnel that are received at the external interface cannot
flow until packets from the same tunnel are received at the internal interface.

If you have bi-directional policies that accept GTPUDP sessions then traffic in either direction that uses an
established tunnel can continue to flow after a failover without interruption.

SSL offloading and HTTP multiplexing session failover

SSL offloading and HTTPmultiplexing are both enabled from firewall virtual IPs and firewall load balancing.
Similar to the features applied by security profile, SSL offloading and HTTPmultiplexing requires the FortiGate to
maintain very large amounts of internal state information for each session. Sessions accepted by security policies
containing virtual IPs or virtual servers with SSL offloading or HTTPmultiplexing enabled do not resume after a
failover.

Active-active HA subordinate units sessions can resume after a failover

In an active-active cluster, subordinate units process sessions. After a failover, all cluster units that are still
operating may be able to continue processing the sessions that they were processing before the failover. These
sessions are maintained because after the failover the new primary unit uses the HA session table to continue to
send session packets to the cluster units that were processing the sessions before the failover. Cluster units
maintain their own information about the sessions that they are processing and this information is not affected by
the failover. In this way, the cluster units that are still operating can continue processing their own sessions
without loss of data.

The cluster keeps processing as many sessions as it can. But some sessions can be lost. Depending on what
caused the failover, sessions can be lost in the following ways:

l A cluster unit fails (the primary unit or a subordinate unit). All sessions that were being processed by that cluster unit
are lost.

l A link failure occurs. All sessions that were being processed through the network interface that failed are lost.

This mechanism for continuing sessions is not the same as session failover because:

l Only the sessions that can be maintained are maintained.
l The sessions are maintained on the same cluster units and not re-distributed.
l Sessions that cannot be maintained are lost.

Session failover limitations for sessions terminated by the cluster
This section contains information about session failover for communication sessions terminated by the cluster.
Sessions terminated by the cluster include management sessions as well as IPsec and SSL VPN, WAN
Optimization and so on between the cluster and a client.
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In general, most sessions terminated by the cluster have to be restarted after a failover. There are some
exceptions though, for example, the FGCP provides failover for IPsec and SSL VPN sessions terminated by the
cluster.

The session pickup setting does not affect session failover for sessions terminated by
the cluster. Also other cluster settings such as active-active or active-passive mode do
not affect session failover for sessions terminated by the cluster.

Protocol Session Failover?

Administrative or management
connections such as connecting to
the GUI or CLI, SNMP, syslog,
communication with FortiManager,
FortiAnalyzer and so on.

Not supported, sessions have to be restarted.

Explicit web proxy, WCCP, WAN
Optimization and Web Caching.

Not supported, sessions have to be restarted. (Explicit web proxy, explicit
FTP proxy, WCCP, WAN optimization and Web Caching session failover on
page 1959)

IPsec VPN tunnels terminating at the
FortiGate

Supported. SAs and related IPsec VPN tunnel data is synchronized to
cluster members. (Synchronizing IPsec VPN SAs on page 1960)

SSL VPN tunnels terminating at the
FortiGate

Partially supported. Sessions are not synchronized and have to be restarted.
Authentication failover and cookie failover is supported for SSL VPN web
mode sessions. Authentication failover is not supported for FortiClient SSL
VPN sessions. (SSL VPN session failover and SSL VPN authentication
failover on page 1960)

PPTP and L2TP VPN terminating at
the FortiGate

Not supported, sessions have to be restarted.

Explicit web proxy, explicit FTP proxy, WCCP, WAN optimization and Web Caching session
failover

Explicit web proxy, explicit FTP proxy, WCCP, WAN optimization and web caching sessions all require the
FortiGate to maintain very large amounts of internal state information for each session. This information is not
maintained and these sessions do not resume after a failover.

The active-passive HA clustering is recommended for WAN optimization. All WAN optimization sessions are
processed by the primary unit only. Even if the cluster is operating in active-active mode, HA does not load-
balance WAN optimization sessions.

Also, Web cache and byte cache databases are only stored on the primary unit. These databases are not
synchronized to the cluster. So, after a failover, the new primary unit must rebuild its web and byte caches. As
well, the new primary unit cannot connect to a SAS partition that the failed primary unit used.

Rebuilding the byte caches can happen relatively quickly because the new primary unit gets byte cache data from
the other FortiGates that it is participating with in WAN optimization tunnels.
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SSL VPN session failover and SSL VPN authentication failover

Session failover is not supported for SSL VPN tunnels. However, authentication failover is supported for SSL VPN
web mode sessions. This means that after a failover, SSL VPN web mode sessions can re-establish the SSL VPN
session between the SSL VPN client and the FortiGate without having to authenticate again.

Authentication failover is not supported for FortiClient SSL VPN sessions.

All sessions inside the SSL VPN tunnel that were running before the failover are stopped and have to be
restarted. For example, file transfers that were in progress would have to be restarted. As well, any
communication sessions with resources behind the FortiGate that are started by an SSL VPN session have to be
restarted.

To support SSL VPN cookie failover, when an SSL VPN session starts, the FGCP distributes the cookie created to
identify the SSL VPN session to all cluster units.

PPTP and L2TP VPN sessions

PPTP and L2TP VPNs are supported in HAmode. For a cluster you can configure PPTP and L2TP settings and
you can also add security policies to allow PPTP and L2TP pass through. However, the FGCP does not provide
session failover for PPTP or L2TP. After a failover, all active PPTP and L2TP sessions are lost and must be
restarted.

Synchronizing IPsec VPN SAs
The FGCP synchronizes IPsec security associations (SAs) between cluster members so that if a failover occurs,
the cluster can resume IPsec sessions without having to establish new SAs. The result is improved failover
performance because IPsec sessions are not interrupted to establish new SAs. Also, establishing a large number
of SAs can reduce cluster performance.

The FGCP implements slightly different synchronization mechanisms for IKEv1 and IKEv2.

Synchronizing SAs for IKEv1

When an SA is synchronized to the subordinate units. the sequence number is set to the maximum sequence
number. After a failover, all inbound traffic that connects with the new primary unit and uses the SAwill be
accepted without needing to re-key. However, first outbound packet to use the SA causes the sequence number
to overflow and so causes the new primary unit to re-key the SA.

Please note the following:

l The cluster synchronizes all IPsec SAs.
l IPsec SAs are not synchronized until the IKE process has finished synchronizing the ISAKMPSAs. This is required

in for dialup tunnels since it is the synchronizing of the ISAKMPSA that creates the dialup tunnel.
l A dialup interface is created as soon as the phase 1 is complete. This ensures that the when HA synchronizes phase

1 information the dialup name is included.
l If the IKE process re-starts for any reason it deletes any dialup tunnels that exist. This forces the peer to re-key

them.
l IPsec SA deletion happens immediately. Routes associated with a dialup tunnel that is being deleted are cleaned

up synchronously as part of the delete, rather than waiting for the SA hard-expiry.
l The FGCP does not sync the IPsec tunnel MTU from the primary unit to the subordinate units. This means that

after HA failover if the first packet received by the FortiGate arrives after the HA route has been deleted and before
the new route is added and the packet is larger than the default MTU of 1024 then the FortiGate sends back an
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ICMP fragmentation required. However, as soon as routing is re-established then the MTU will be corrected and
traffic will flow.

Synchronizing SAs for IKEv2

Due to the way the IKEv2 protocol is designed the FGCP cannot use exactly the same solution that is used for
synchronizing IKEv1 SAs, though it is similar.

For IKEv2, like IKEv1, the FGCP synchronizes IKE and ISAKMPSAs from the primary unit to the subordinate
units. However, for IKEv2 the FGCP cannot actually use this IKE SA to send/receive IKE traffic because IKEv2
includes a sequence number in every IKEmessage and thus it would require synchronizing every message to the
subordinate units to keep the sequence numbers on the subordinate units up to date.

Instead, the FGCP synchronizes IKEv2 Message IDs. This Message ID Sync allows IKEv2 to re-negotiate send
and receive message ID counters after a failover. By doing this, the established IKE SA can remain up, instead of
re-negotiating.

The diagnose vpn ike stats command shows statistics for the number of HAmessages sent/received for
IKEv2. The output of this command includes a number of fields prefixed with ha that contain high availability
related-data. For example:

.

.

.
ha.resync: 0
ha.vike.sync: 0
ha.conn.sync: 0
ha.sync.tx: 1
ha.sync.rx: 0
ha.sync.rx.len.bad: 0
.
.
.

WAN optimization and HA
You can configure WAN optimization on a FortiGate HA cluster. The recommended HA configuration for WAN
optimization is active-passive mode. Also, when the cluster is operating, all WAN optimization sessions are
processed by the primary unit only. Even if the cluster is operating in active-active mode, HA does not load-
balance WAN optimization sessions. HA also does not support WAN optimization session failover.

In a cluster, the primary unit only stores web cache and byte cache databases. These databases are not
synchronized to the subordinate units. So, after a failover, the new primary unit must rebuild its web and byte
caches. As well, the new primary unit cannot connect to a SAS partition that the failed primary unit used.

Rebuilding the byte caches can happen relatively quickly because the new primary unit gets byte cache data from
the other FortiGates that it is participating with in WAN optimization tunnels.
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FGCP active-active (a-a) load balancing distributes network traffic among all of the units in a cluster. Load
balancing can improve cluster performance because the processing load is shared among multiple cluster units.

This chapter describes how active-active load balancing works and provides detailed active-active HANAT and
transparent mode packet flow descriptions.

Load balancing overview
FGCP active-active HA uses a technique similar to unicast load balancing in which the primary unit is associated
with the cluster HA virtual MAC addresses and cluster IP addresses. The primary unit is the only cluster unit to
receive packets sent to the cluster. The primary unit then uses a load balancing schedule to distribute sessions to
all of the units in the cluster (including the primary unit). Subordinate unit interfaces retain their actual MAC
addresses and the primary unit communicates with the subordinate units using these MAC addresses. Packets
exiting the subordinate units proceed directly to their destination and do not pass through the primary unit first.

By default, active-active HA load balancing distributes proxy-based security profile processing to all cluster units.
Proxy-based security profile processing is CPU and memory-intensive, so FGCP load balancing may result in
higher throughput because resource-intensive processing is distributed among all cluster units.

Proxy-based security profile processing that is load balanced includes proxy-based virus scanning, proxy-based
web filtering, proxy-based email filtering, and proxy-based data leak prevention (DLP) of HTTP, FTP, IMAP,
IMAPS, POP3, POP3S, SMTP, SMTPS, IM, and NNTP, sessions accepted by security policies.

Other features enabled in security policies such as Endpoint security, traffic shaping and authentication have no
effect on active-active load balancing.

You can also enable load-balance-all to have the primary unit load balance all TCP sessions. Load
balancing TCP sessions increases overhead and may actually reduce performance so it is disabled by default.
You can also enable load-balance-udp to have the primary unit load balance all UDP sessions. Load
balancing UDP sessions also increases overhead so it is also disabled by default.

NP4 and NP6 processors can also offload and accelerate load balancing.

During active-active HA load balancing the primary unit uses the configured load balancing schedule to determine
the cluster unit that will process a session. The primary unit stores the load balancing information for each load
balanced session in the cluster load balancing session table. Using the information in this table, the primary unit
can then forward all of the remaining packets in each session to the appropriate cluster unit. The load balancing
session table is synchronized among all cluster units.

HTTPS, ICMP, multicast, and broadcast sessions are never load balanced and are always processed by the
primary unit. IPS, Application Control, flow-based virus scanning, flow-based web filtering, flow-based DLP, flow-
based email filtering, VoIP, IM, P2P, IPsec VPN, HTTPS, SSL VPN, HTTPmultiplexing, SSL offloading, WAN
optimization, explicit web proxy, and WCCP sessions are also always processed only by the primary unit.

In addition to load balancing, active-active HA also provides the same session, device and link failover protection
as active-passive HA. If the primary unit fails, a subordinate unit becomes the primary unit and resumes operating
the cluster.
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Active-active HA also maintains as many load balanced sessions as possible after a failover by continuing to
process the load balanced sessions that were being processed by the cluster units that are still operating. See
Active-active HA subordinate units sessions can resume after a failover on page 1958 for more information.

Load balancing schedules

The load balancing schedule controls how the primary unit distributes packets to all cluster units. You can select
from the following load balancing schedules.

Schedule Description

None No load balancing. Select None when the cluster interfaces are connected to load
balancing switches. If you select None, the Primary unit does not load balance traffic
and the subordinate units process incoming traffic that does not come from the
Primary unit. For all other load balancing schedules, all traffic is received first by the
Primary unit, and then forwarded to the subordinate units. The subordinate units only
receive and process packets sent from the primary unit.

Hub Load balancing if the cluster interfaces are connected to a hub. Traffic is distributed to
cluster units based on the source IP and destination IP of the packet.

Least-Connection If the cluster units are connected using switches, select Least Connection to
distribute network traffic to the cluster unit currently processing the fewest
connections.

Round-Robin If the cluster units are connected using switches, select Round-Robin to distribute
network traffic to the next available cluster unit.

Weighted
Round-Robin

Similar to round robin, but weighted values are assigned to each of the units in a
cluster based on their capacity and on how many connections they are currently
processing. For example, the primary unit should have a lower weighted value
because it handles scheduling and forwards traffic. Weighted round robin distributes
traffic more evenly because units that are not processing traffic will be more likely to
receive new connections than units that are very busy.

Random If the cluster units are connected using switches, select Random to randomly
distribute traffic to cluster units.

IP Load balancing according to IP address. If the cluster units are connected using
switches, select IP to distribute traffic to units in a cluster based on the source IP and
destination IP of the packet.

IP Port
Load balancing according to IP address and port. If the cluster units are connected
using switches, select IP Port to distribute traffic to units in a cluster based on the
source IP, source port, destination IP, and destination port of the packet.

Once a packet has been propagated to a subordinate unit, all packets are part of that same communication
session are also propagated to that same subordinate unit. Traffic is distributed according to communication
session, not just according to individual packet.

Any subordinate unit that receives a forwarded packet processes it, without applying load balancing. Note that
subordinate units are still considered to be active, because they perform routing, virus scanning, and other
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FortiGate tasks on their share of the traffic. Active subordinate units also share their session and link status
information with all cluster units. The only things that active members do not do is make load balancing
decisions.

Even though the primary unit is responsible for the load balancing process, the primary unit still acts like a
FortiGate in that it processes packets, performing, routing, firewall, virus scanning, and other FortiGate tasks on
its share of the traffic. Depending on the load balancing schedule used, the primary unit may assign itself a
smaller share of the total load.

More about active-active failover

If a subordinate unit fails, the primary unit re-distributes the sessions that the subordinate was processing among
the remaining active cluster members. If the primary unit fails, the subordinate units negotiate to select a new
primary unit. The new primary unit continues to distribute packets among the remaining active cluster units.

Failover works in a similar way if the cluster consists of only two units. If the primary unit fails the subordinate unit
negotiates and becomes the new primary unit. If the subordinate unit fails, the primary unit processes all traffic.
In both cases, the single remaining unit continues to function as a primary unit, maintaining the HA virtual MAC
address for all of its interfaces.

HTTPS sessions, active-active load balancing, and proxy servers

To prevent HTTPSweb filtering problems active-active HA does not load balance HTTPS sessions. The
FortiGate identifies HTTPS sessions as all sessions received on the HTTPS TCP port. The default HTTPS port is
443. You can go to Policy & Objects > Policy > SSL/SSH Inspection to use a custom port for HTTPS
sessions. If you change the HTTPS port, the FGCP stops load balancing all sessions that use the custom HTTPS
port.

Normally you would not change the HTTPS port. However, if your network uses a proxy server for HTTPS traffic
you may have to change to the custom HTTPS port used by your proxy server. If your network uses a proxy server
you might also use the same port for both HTTP and HTTPS traffic. In this case you would configure the
FortiGate to use custom ports for both HTTP and HTTPS traffic. Go to Policy & Objects > Policy > Proxy
Options to use a custom port for HTTP.

Using the same port for HTTP and HTTPS traffic can cause problems with active-active clusters because active-
active clusters always load balance HTTP traffic. If both HTTP and HTTPS use the same port, the active-active
cluster cannot differentiate between HTTP and HTTPS traffic and will load balance both.

As mentioned above, load balancing HTTPS traffic may cause problems with HTTPSweb filtering. To avoid this
problem, you should configure your proxy server to use different ports for HTTP and HTTPS traffic. Then
configure your cluster to also use different ports for HTTP and HTTPS.

Selecting a load balancing schedule
You can select the load balancing schedule when initially configuring the cluster and you can change the load
balancing schedule at any time while the cluster is operating without affecting cluster operation.

You can select a load balancing schedule from the CLI. Use the following command to select a load balancing
schedule:

config system ha
set schedule {hub | ip | ipport | leastconnection | none | random | round-robin

| weight-round-robin}
end
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Load balancing TCP and UDP sessions
You can use the following command to configure the cluster to load balance TCP sessions in addition to security
profile sessions.

config system ha
set load-balance-all enable

end

Enabling load-balance-all to add load balancing of TCP sessions may not improve performance because
the cluster requires additional overhead to load balance sessions. Load balancing aTCP session usually requires
about as much overhead as just processing it. On the other hand, TCP load balancing performance may be
improved if your FortiGate includes NP4 or NP6 processors.

You can enable load-balance-all and monitor network performance to see if it improves. If performance is
not improved, you might want to change the HAmode to active-passive since active-active HA is not providing
any benefit.

On some FortiGate models you can use the following command to also load balance UDP sessions:

config system ha
set load-balance-udp enable

end

Similar to load balancing TCP sessions, load balancing UDP sessions may also not improve performance. Also
UDP load balancing performance may be improved with NP4 and NP6 processors.

Using NP4 or NP6 processors to offload load balancing
FortiGates that include NP4 and NP6 network processors can provide hardware acceleration for active-active HA
cluster by offloading load balancing from the primary unit CPU. Network processors are especially useful when
load balancing TCP and UDP sessions.

The first packet of every new session is received by the primary unit and the primary unit uses its load balancing
schedule to select the cluster unit that will process the new session. This information is passed back to the
network processor and all subsequent packets of the same sessions are offloaded to the network processor which
sends the packet directly to a subordinate unit. Load balancing is effectively offloaded from the primary unit to the
network processor resulting in a faster and more stable active-active cluster.

To take advantage of network processor load balancing acceleration, connect the cluster unit interfaces with
network processors to the busiest networks. Connect other interfaces to less busy networks. No special FortiOS
or HA configuration is required. Network processor acceleration of active-active HA load balancing is supported
for any active-active HA configuration or active-active HA load balancing schedule.

Configuring weighted-round-robin weights
You can configure weighted round-robin load balancing for a cluster and configure the static weights for each of
the cluster units according to their priority in the cluster. When you set schedule to weight-round-robin
you can use the weight option to set the static weight of each cluster unit. The static weight is set according to
the priority of each unit in the cluster. A FortiGate HA cluster can contain up to four FortiGates so you can set up
to 4 static weights.

The priority of a cluster unit is determined by its device priority, the number of monitored interfaces that are
functioning, its age in the cluster and its serial number. Priorities are used to select a primary unit and to set the
priorities of all of the subordinate units. Thus the priority of a cluster unit can change depending on configuration
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settings, link failures and so on. Since weights are also set using this priority, the weights are independent of
specific cluster units but do depend on the role of the each unit in the cluster.

You can use the following command to display the relative priorities of the units in a cluster. The cluster unit serial
numbers and their priorities are listed in the last few lines of the command output. This example shows a cluster
of three FortiGates:

get system ha status
.
.
.
Slave : FG-5KD3914800284, operating cluster index = 1
Master: FG-5KD3914800344, operating cluster index = 0
Slave : FG-5KD3914800353, operating cluster index = 2

The primary unit always has the highest priority and the subordinate units have lower priorities.

The default static weight for each cluster unit is 40. This means that sessions are distributed evenly among all
cluster units. You can use the set weight command to change the static weights of cluster units to distribute
sessions to cluster units depending on their priority in the cluster. The weight can be between 0 and 255. Increase
the weight to increase the number of connections processed by the cluster unit with that priority.

You set the weight for each unit separately. For the example cluster of 3 FortiGates you can set the weight for
each unit as follows:

config system ha
set mode a-a
set schedule weight-roud-robin
set weight 0 5
set weight 1 10
set weight 2 15

end

If you enter the get command to view the HA configuration the output for weight would be:

weight 5 10 15 40 40 40 40 40 40 40 40 40 40 40 40 40

This configuration has the following results if the output of the get system ha status command is that
shown above:

l The first five connections are processed by the primary unit (priority 0, weight 5).
l The next 10 connections are processed by the first subordinate unit (priority 1, weight 10)
l The next 15 connections are processed by the second subordinate unit (priority 2, weight 15)

Dynamically optimizing weighted load balancing according to how busy cluster units are
In conjunction with using static weights to load balance sessions among cluster units you can configure a cluster
to dynamically load balance sessions according to individual cluster unit CPU usage, memory usage, and number
of HTTP, FTP, IMAP, POP3, SMTP, or NNTP proxy-based security profile sessions. If any of these system
loading indicators increases above configured thresholds, weighted load balancing dynamically sends fewer new
sessions to the busy unit until it recovers.

High CPU or memory usage indicates that a unit is under increased load and may not be able to process more
sessions. HTTP, FTP, IMAP, POP3, SMTP, or NNTP proxy use are also good indicators of how busy a cluster unit
is, since processing high numbers of these proxy sessions can quickly reduce overall cluster unit performance.
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For example, you can set a CPU usage high watermark threshold. When a cluster unit reaches this high
watermark threshold fewer sessions are sent to it. With fewer sessions to process the cluster unit’s CPU usage
should fall back to the low watermark threshold. When the low watermark threshold is reached the cluster
resumes normal load balancing of sessions to the cluster unit.

You can set individual high and low watermark thresholds and weights for CPU usage, memory usage, and for the
number of HTTP, FTP, IMAP, POP3, SMTP, or NNTP proxy sessions.

The CPU usage, memory usage, and proxy weights determine how the cluster load balances sessions when a
high watermark threshold is reached and also affect how the cluster load balances sessions when multiple cluster
units reach different high watermark thresholds at the same time. For example, you might be less concerned
about a cluster unit reaching the memory usage high watermark threshold than reaching the CPU usage high
watermark threshold. If this is the case you can set the weight lower for memory usage. Then, if one cluster unit
reaches the CPU usage high watermark threshold and a second cluster unit reaches the memory usage high
watermark threshold the cluster will load balance more sessions to the cluster unit with high memory usage and
fewer sessions to the cluster unit with high CPU usage. As a result, reaching the CPU usage high watermark will
have a greater affect on how sessions are redistributed than reaching the memory usage high watermark.

When a high watermark threshold is reached, the corresponding weight is subtracted from the static weight of the
cluster unit. The lower the weight the fewer the number of sessions that are load balanced to that unit.
Subsequently when the low watermark threshold is reached, the static weight of the cluster unit returns to its
configured value. For the weights to all be effective the weights assigned to the load indicators should usually be
lower than or equal to the static weights assigned to the cluster units.

Use the following command to set thresholds and weights for CPU and memory usage and HTTP, FTP, IMAP,
POP3, SMTP, or NNTP proxy sessions:

config system ha
set mode a-a
set schedule weight-round-robin
set cpu-threshold <weight> <low> <high>
set memory-threshold <weight> <low> <high>
set http-proxy-threshold <weight> <low> <high>
set ftp-proxy-threshold <weight> <low> <high>
set imap-proxy-threshold <weight> <low> <high>
set nntp-proxy-threshold <weight> <low> <high>
set pop3-proxy-threshold <weight> <low> <high>
set smtp-proxy-threshold <weight> <low> <high>

end

For each option, the weight range is 0 to 255 and the default weight is 5. The low and high watermarks are a
percent (0 to 100). The default low and high watermarks are 0 which means they are disabled. The default
configuration when weighted load balancing is enabled looks like the following:

config system ha
set mode a-a
set schedule weight-round-robin
set cpu-threshold 5 0 0
set memory-threshold 5 0 0
set http-proxy-threshold 5 0 0
set ftp-proxy-threshold 5 0 0
set imap-proxy-threshold 5 0 0
set nntp-proxy-threshold 5 0 0
set pop3-proxy-threshold 5 0 0
set smtp-proxy-threshold 5 0 0

end
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When you first enable HAweighted load balancing, the weighted load balancing
configuration is synchronized to all cluster units and each cluster unit has the default
configuration shown above. Changes to the CPU, memory, HTTP, FTP, IMAP, NNTP,
POP3, and SMTP proxy thresholds and low and high watermarks must be made for
each cluster unit and are not synchronized to the other cluster units.

When you configure them, the high watermarks must be greater than their corresponding low watermarks.

For CPU and memory usage the low and high watermarks are compared with the percentage CPU and memory
use of the cluster unit. For each of the proxies the high and low watermarks are compared to a number that
represents percent of the max number of proxy sessions being used by a proxy. This number is calculated using
the formula:

proxy usage = (current sessions * 100) / max sessions

where:

current sessions is the number of active sessions for the proxy type.

max sessions is the session limit for the proxy type. The session limit depends on the FortiGate and its
configuration.

You can use the following command to display the maximum and current number of sessions for a proxy:

get test {ftpd | http | imap | nntp | pop3 | smtp} 4

You can use the following command to display the maximum number of sessions and the and current number of
sessions for all of the proxies:

get test proxyworker 4

The command output includes lines similar to the following:

get test http 4
HTTP Common
Current Connections             5000/8032

In the example, 5000 is the current number of proxy connections being used by HTTP and 8032 is the maximum
number of proxy sessions allowed. For this example the proxy usage would be:

proxy usage = (5000 * 100) / 8032
proxy usage = 62%

Example weighted load balancing configuration
Consider a cluster of three FortiGates with host names FGT_ha_1, FGT_ha_2, and FGT_ha_3 as shown below.
This example describes how to configure weighted load balancing settings for CPU and memory usage for the
cluster and then to configure HTTP and POP3 proxy weights to send most HTTP and POP3 proxy sessions to
different cluster units.
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Example HA weighted load balancing configuration

Connect to the cluster CLI and use the following command to set the CPU usage threshold weight to 30, low
watermark to 60, and high watermark to 80. This command also sets the memory usage threshold weight to 10,
low watermark to 60, and high watermark to 90.

config system ha
set mode a-a
set schedule weight-round-robin
set cpu-threshold 30 60 80
set memory-threshold 10 60 90

end

The static weights for the cluster units remain at the default values of 40. Since this command changes the mode
to a-a and the schedule to weight-round-robin for the first time, the weight settings are synchronized to all
cluster units.

As a result of this configuration, if the CPU usage of any cluster unit (for example, FGT_ha_1) reaches 80% the
static weight for that cluster unit is reduced from 40 to 10 and only 10 of every 120 new sessions are load
balanced to this cluster unit. If the memory usage of FGT_ha_1 also reaches 90% the static weight further
reduces to 0 and no new sessions are load balanced to FGT_ha_1. Also, if the memory usage of 620_ha_2
reaches 90% the static weight of FGT_ha_2 reduces to 30 and 30 of every 120 new sessions are load balanced to
FGT_ha_2.

Now that you have established the weight load balancing configuration for the entire cluster you can monitor the
cluster to verify that processing gets distributed evenly to all cluster units. From the GUI you can go do System >
HA > View HA Statistics and see the CPU usage, active sessions, memory usage and other statistics for all of
the cluster units. If you notice that one cluster unit is more or less busy than others you can adjust the dynamic
weights separately for each cluster unit.
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For example, in some active-active clusters the primary unit may tend to be busier than other cluster units
because in addition to processing sessions the primary unit also receives all packets sent to the cluster and
performs load balancing to distribute the sessions to other cluster units. To reduce the load on the primary unit
you could reduce the CPU and memory usage high watermark thresholds for the primary unit so that fewer
sessions are distributed to the primary unit. You could also reduce the primary unit’s high watermark setting for
the proxies to distribute more proxy sessions to other cluster units.

This would only be useful if you are using device priorities and override
settings to make sure the same unit always becomes the primary unit. See
Controlling primary unit selection using device priority and override on page
1754.

If the example cluster is configured for FGT_ha_2 to be the primary unit, connect to the FGT_ha_2’s CLI and
enter the following command to set CPU usage, memory usage, and proxy usage high watermark thresholds
lower.

config system ha
set cpu-threshold 30 60 70
set memory-threshold 30 60 70
set http-proxy-threshold 30 60 70
set ftp-proxy-threshold 30 60 70
set imap-proxy-threshold 30 60 70
set nntp-proxy-threshold 30 60 70
set pop3-proxy-threshold 30 60 70
set smtp-proxy-threshold 30 60 70

end

As a result, when any of these factors reaches 70% on the primary unit, fewer sessions will be processed by the
primary unit, preventing the number of sessions being processed from rising.

NAT mode active-active cluster packet flow
This section describes an example of how packets are load balanced and how failover occurs in an active-active
HA cluster running in NAT mode. In the example, the NAT mode cluster acts as the internet firewall for a client
computer’s internal network. The client computer’s default route points at the IP address of the cluster internal
interface. The client connects to a web server on the Internet. Internet routing routes packets from the cluster
external interface to the web server, and from the web server to the cluster external interface.

In NAT mode, eight MAC addresses are involved in active-active communication between the client and the web
server when the primary unit load balances packets to the subordinate unit:

l Internal virtual MAC address (MAC_V_int) assigned to the primary unit internal interface,
l External virtual MAC address (MAC_V_ext) assigned to the primary unit external interface,
l Client MAC address (MAC_Client),
l Server MAC address (MAC_Server),
l Primary unit original internal MAC address (MAC_P_int),
l Primary unit original external MAC address (MAC_P_ext),
l Subordinate unit internal MAC address (MAC_S_int),
l Subordinate unit external MAC address (MAC_S_ext).
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In NAT mode, the HA cluster works as a gateway when it responds to ARP requests. Therefore, the client and
server only know the gateway MAC addresses. The client only knows the cluster internal virtual MAC address
(MAC_V_int) and the server only knows the cluster external virtual MAC address (MAC_V_ext).

NAT mode active-active packet flow

Packet flow from client to web server

1. The client computer requests a connection from 10.11.101.10 to 172.20.120.130.
2. The default route on the client computer recognizes 10.11.101.100 (the cluster IP address) as the gateway to the

external network where the web server is located.
3. The client computer issues an ARP request to 10.11.101.100.
4. The primary unit intercepts the ARP request, and responds with the internal virtual MAC address (MAC_V_int)

which corresponds to its IP address of 10.11.101.100.
5. The client’s request packet reaches the primary unit internal interface.

IP address MAC address

Source 10.11.101.10 MAC_Client

Destination 172.20.120.130 MAC_V_int

6. The primary unit decides that the subordinate unit should handle this packet, and forwards it to the subordinate
unit internal interface. The source MAC address of the forwarded packet is changed to the actual MAC address of
the primary unit internal interface.

IP address MAC address
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Source 10.11.101.10 MAC_P_int

Destination 172.20.120.130 MAC_S_int

7. The subordinate unit recognizes that the packet has been forwarded from the primary unit and processes it.
8. The subordinate unit forwards the packet from its external interface to the web server.

IP address MAC address

Source 172.20.120.141 MAC_S_ext

Destination 172.20.120.130 MAC_Server

9. The primary unit forwards further packets in the same session to the subordinate unit.
10. Packets for other sessions are load balanced by the primary unit and either sent to the subordinate unit or

processed by the primary unit.

Packet flow from web server to client

1. When the web server responds to the client’s packet, the cluster external interface IP address (172.20.120.141) is
recognized as the gateway to the internal network.

2. The web server issues an ARP request to 172.20.120.141.
3. The primary unit intercepts the ARP request, and responds with the external virtual MAC address (MAC_V_ext)

which corresponds its IP address of 172.20.120.141.
4. The web server then sends response packets to the primary unit external interface.

IP address MAC address

Source 172.20.120.130 MAC_Server

Destination 172.20.120.141 MAC_V_ext

5. The primary unit decides that the subordinate unit should handle this packet, and forwards it to the subordinate
unit external interface. The source MAC address of the forwarded packet is changed to the actual MAC address of
the primary unit external interface.

IP address MAC address

Source 172.20.120.130 MAC_P_ext

Destination 172.20.120.141 MAC_S_ext

6. The subordinate unit recognizes that packet has been forwarded from the primary unit and processes it.
7. The subordinate unit forwards the packet from its internal interface to the client.

IP address MAC address

Source 172.20.120.130 MAC_S_int

Destination 10.11.101.10 MAC_Client
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8. The primary unit forwards further packets in the same session to the subordinate unit.
9. Packets for other sessions are load balanced by the primary unit and either sent to the subordinate unit or

processed by the primary unit.

When a failover occurs

The following steps are followed after a device or link failure of the primary unit causes a failover.

1. If the primary unit fails, the subordinate unit negotiates to become the primary unit.
2. The new primary unit changes the MAC addresses of all of its interfaces to the HA virtual MAC addresses.

The new primary unit has the same IP addresses and MAC addresses as the failed primary unit.

3. The new primary units sends gratuitous ARP packets to the 10.10.101.0 network to associate its internal IP
address with the internal virtual MAC address.

4. The new primary units sends gratuitous ARP packets to the 172.20.120.0 network to associate its external IP
address with the external virtual MAC address.

5. Traffic sent to the cluster is now received and processed by the new primary unit.
If there were more than two cluster units in the original cluster, the new primary unit would load
balance packets to the remaining cluster members.

Transparent mode active-active cluster packet flow
This section describes an example of how packets are load balanced and how failover occurs in an active-active
HA cluster running in transparent mode. The cluster is installed on an internal network in front of a mail server and
the client connects to the mail server through the transparent mode cluster.

In transparent mode, six MAC addresses are involved in active-active communication between a client and a
server when the primary unit load balances packets to the subordinate unit:

l Client MAC address (MAC_Client),
l Server MAC address (MAC_Server),
l Primary unit original internal MAC address (MAC_P_int),
l Primary unit original external MAC address (MAC_P_ext),
l Subordinate unit internal MAC address (MAC_S_int),
l Subordinate unit external MAC address (MAC_S_ext).

The HA virtual MAC addresses are not directly involved in communicate between the client and the server. The
client computer sends packets to the mail server and the mail server sends responses. In both cases the packets
are intercepted and load balanced among cluster members.

The cluster’s presence on the network and its load balancing are transparent to the client and server computers.
The primary unit sends gratuitous ARP packets to Switch 1 that associate all MAC addresses on the network
segment connected to the cluster external interface with the external virtual MAC address. The primary unit also
sends gratuitous ARP packets to Switch 2 that associate all MAC addresses on the network segment connected
to the cluster internal interface with the internal virtual MAC address. In both cases, this results in the switches
sending packets to the primary unit interfaces.
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Transparent mode active-active packet flow

Packet flow from client to mail server

1. The client computer requests a connection from 10.11.101.10 to 10.11.101.200.
2. The client computer issues an ARP request to 10.11.101.200.
3. The primary unit forwards the ARP request to the mail server.
4. The mail server responds with its MAC address (MAC_Server) which corresponds to its IP address of

10.11.101.200. The primary unit returns the ARP response to the client computer.
5. The client’s request packet reaches the primary unit internal interface.

IP address MAC address

Source 10.11.101.10 MAC_Client

Destination 10.11.101.200 MAC_Server

6. The primary unit decides that the subordinate unit should handle this packet, and forwards it to the subordinate
unit internal interface. The source MAC address of the forwarded packet is changed to the actual MAC address of
the primary unit internal interface.

IP address MAC address

Source 10.11.101.10 MAC_P_int

Destination 10.11.101.200 MAC_S_int

7. The subordinate unit recognizes that packet has been forwarded from the primary unit and processes it.
8. The subordinate unit forwards the packet from its external interface to the mail server.
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IP address MAC address

Source 10.11.101.10 MAC_S_ext

Destination 10.11.101.200 MAC_Server

9. The primary unit forwards further packets in the same session to the subordinate unit.
10. Packets for other sessions are load balanced by the primary unit and either sent to the subordinate unit or

processed by the primary unit.

Packet flow from mail server to client

1. To respond to the client computer, the mail server issues an ARP request to 10.11.101.10.
2. The primary unit forwards the ARP request to the client computer.
3. The client computer responds with its MAC address (MAC_Client) which corresponds to its IP address of

10.11.101.10. The primary unit returns the ARP response to the mail server.
4. The mail server’s response packet reaches the primary unit external interface.

IP address MAC address

Source 10.11.101.200 MAC_Server

Destination 10.11.101.10 MAC_Client

5. The primary unit decides that the subordinate unit should handle this packet, and forwards it to the subordinate
unit external interface. The source MAC address of the forwarded packet is changed to the actual MAC address of
the primary unit external interface.

IP address MAC address

Source 10.11.101.200 MAC_P_ext

Destination 10.11.101.10 MAC_S_ext

6. The subordinate unit recognizes that packet has been forwarded from the primary unit and processes it.
7. The subordinate unit forwards the packet from its internal interface to the client.

IP address MAC address

Source 10.11.101.200 MAC_S_int

Destination 10.11.101.10 MAC_Client

8. The primary unit forwards further packets in the same session to the subordinate unit.
9. Packets for other sessions are load balanced by the primary unit and either sent to the subordinate unit or

processed by the primary unit.

When a failover occurs

The following steps are followed after a device or link failure of the primary unit causes a failover.
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1. If the primary unit fails the subordinate unit negotiates to become the primary unit.
2. The new primary unit changes the MAC addresses of all of its interfaces to the HA virtual MAC address.
3. The new primary units sends gratuitous ARP requests to switch 1 to associate its MAC address with the MAC

addresses on the network segment connected to the external interface.
4. The new primary units sends gratuitous ARP requests to switch 2 to associate its MAC address with the MAC

addresses on the network segment connected to the internal interface.
5. Traffic sent to the cluster is now received and processed by the new primary unit.

If there were more than two cluster units in the original cluster, the new primary unit would load
balance packets to the remaining cluster members.
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This chapter provides information about operating FortiOS VM cluster and operating FortiGate clusters with third
party products such as layer-2 and layer-3 switches.

FortiGate-VM for VMware HA configuration
If you want to combine two or more FortiGate-VM instances into a FortiGate Clustering Protocol (FGSP) High
Availability (HA) cluster the VMware server’s virtual switches used to connect the heartbeat interfaces must
operate in promiscuous mode. This permits HA heartbeat communication between the heartbeat interfaces. HA
heartbeat packets are non-TCP packets that use Ethertype values 0x8890, 0x8891, and 0x8893. All
synchronization activity takes place over the HA heartbeat link using TCP/703 and UDP/703 packets. The FGCP
uses link-local IPv4 addresses in the 169.254.0.x range for HA heartbeat interface IP addresses.

To enable promiscuous mode in VMware:

1. In the vSphere client, select your VMware server in the left pane and then select the Configuration tab in the
right pane.

2. In Hardware, select Networking.
3. Select Properties of a virtual switch used to connect heartbeat interfaces.
4. In the Propertieswindow left pane, select vSwitch and then select Edit.
5. Select the Security tab, set Promiscuous Mode to Accept, then select OK.
6. Select Close.

You must also set the virtual switches connected to other FortiGate interfaces to allow MAC address changes and
to accept forged transmits. This is required because the FGCP sets virtual MAC addresses for all FortiGate
interfaces and the same interfaces on the different VM instances in the cluster will have the same virtual MAC
addresses.

To make the required changes in VMware:

1. In the vSphere client, select your VMware server in the left pane and then select the Configuration tab in the
right pane.

2. In Hardware, select Networking.
3. Select Properties of a virtual switch used to connect FortiGate VM interfaces.
4. SetMAC Address Changes to Accept.
5. Set Forged Transmits to Accept.

FortiGate VM for Hyper-V HA configuration
Promiscuous mode and support for MAC address spoofing is required for FortiGate-VM for Hyper-V to support
FortiGate Clustering Protocol (FGCP) high availability (HA). By default the FortiGate-VM for Hyper-V has
promiscuous mode enabled in the XML configuration file in the FortiGate-VM Hyper-V image. If you have
problems with HAmode, confirm that this is still enabled.

In addition, because the FGCP applies virtual MAC addresses to FortiGate data interfaces and because these
virtual MAC addresses mean that matching interfaces of different FortiGate-VM instances will have the same
virtual MAC addresses you have to configure Hyper-V to allow MAC spoofing. But you should only enable MAC
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spoofing for FortiGate-VM data interfaces. You should not enable MAC spoofing for FortiGate HA heartbeat
interfaces.

With promiscuous mode enabled and the correct MAC spoofing settings you should be able to configure HA
between two or more FortiGate-VM for Hyper-V instances.

Troubleshooting layer-2 switches
Issues may occur because of the way an HA cluster assigns MAC addresses to the primary unit. Two clusters with
the same group ID cannot connect to the same switch and cannot be installed on the same network unless they
are separated by a router.

Forwarding delay on layer 2 switches

You must ensure that if there is a switch between the FortiGate HA cluster and the network its is protecting and
the switch has a forwarding delay (even if spanning tree is disabled) when one of its interfaces is activated then
the forwarding delay should be set as low as possible. For example, some versions of Cisco IOS have a
forwarding delay of 15 seconds even when spanning tree is disabled. If left at this default value then TCP session
pickup can fail because traffic is not forwarded through the switch on HA failover.

Failover issues with layer-3 switches
After a failover, the new primary unit sends gratuitous ARP packets to refresh the MAC forwarding tables of the
switches connected to the cluster. If the cluster is connected using layer-2 switches, the MAC forwarding tables
(also called arp tables) are refreshed by the gratuitous ARP packets and the switches start directing packets to the
new primary unit.

In some configurations that use layer-3 switches, after a failover, the layer-3 switches may not successfully re-
direct traffic to the new primary unit. The possible reason for this is that the layer-3 switch might keep a table of IP
addresses and interfaces and may not update this table for a relatively long time after the failover (the table is not
updated by the gratuitous ARP packets). Until the table is updated, the layer-3 switch keeps forwarding packets to
the now failed cluster unit. As a result, traffic stops and the cluster does not function.

As of the release date of this document, Fortinet has not developed a workaround for this problem. One possible
solution would be to clear the forwarding table on the layer-3 switch.

The config system ha link-failed-signal command described in Updating MAC forwarding tables
when a link failover occurs on page 1940 can be used to resolve link failover issues similar to those described
here.

Failover and attached network equipment
It normally takes a cluster approximately 6 seconds to complete a failover. However, the actual failover time may
depend on how quickly the switches connected to the cluster interfaces accept the cluster MAC address update
from the primary unit. If the switches do not recognize and accept the gratuitous ARP packets and update their
MAC forwarding table, the failover time will increase.

Also, individual session failover depends on whether the cluster is operating in active-active or active-passive
mode, and whether the content of the traffic is to be virus scanned. Depending on application behavior, it may
take a TCP session a longer period of time (up to 30 seconds) to recover completely.
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Ethertype conflicts with third-party switches
Some third-party network equipment may use packets with Ethertypes that are the same as the ethertypes used
for HA heartbeat packets. For example, Cisco N5K/Nexus switches use Ethertype 0x8890 for some functions.
When one of these switches receives Ethertype 0x8890 heartbeat packets from an attached cluster unit, the
switch generates CRC errors and the packets are not forwarded. As a result, FortiGates connected with these
switches cannot form a cluster.

In some cases, if the heartbeat interfaces are connected and configured so regular traffic flows but heartbeat
traffic is not forwarded, you can change the configuration of the switch that connects the HA heartbeat interfaces
to allow level2 frames with Ethertypes 0x8890, 0x8891, and 0x8893 to pass.

You can also use the following CLI commands to change the Ethertypes of the HA heartbeat packets:

config system ha
set ha-eth-type <ha_ethertype_4-digit_hex>
set hc-eth-type <hc_ethertype_4-digit_hex>
set l2ep-eth-type <l2ep_ethertype_4-digit_hex>

end

For more information, see Heartbeat packet Ethertypes on page 1915.

LACP, 802.3ad aggregation and third-party switches
If a cluster contains 802.3ad aggregated interfaces you should connect the cluster to switches that support
configuring multiple Link Aggregation (LAG) groups.

The primary and subordinate unit interfaces have the same MAC address, so if you cannot configure multiple
LAG groups a switch may place all interfaces with the same MAC address into the same LAG group; disrupting
the operation of the cluster.

You can change the FortiGate configuration to prevent subordinate units from participating in LACP negotiation.
For example, use the following command to do this for an aggregate interface named Port1_Port2:

config system interface
edit Port1_Port2

set lacp-ha-slave disable
end

This configuration prevents the subordinate unit interfaces from sending or receiving packets. Resulting in the
cluster not being able to operate in active-active mode. As well, failover may be slower because after a failover
the new primary unit has to perform LACP negotiation before being able to process network traffic.

For more information, see FGCPHAwith 802.3ad aggregated interfaces on page 1823.
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A Virtual Router Redundancy Protocol (VRRP) configuration can be used as a high availability solution to make
sure that a network maintains connectivity with the internet (or with other networks) even if the default router for
the network fails. Using VRRP, if a router or a FortiGate fails, all traffic to this router transparently fails over to
another router or FortiGate that takes over the role of the router or FortiGate that failed. If the failed router or
FortiGate is restored, it will once again take over processing traffic for the network. VRRP is described by RFC
3768.

FortiOS supports VRRP versions 2 and 3 and you can set up VRRP domains that include multiple FortiGates and
other VRRP-compatible routers. You can add different FortiGate models to the same VRRP domain. FortiOS
supports IPv4 VRRP and you can add IPv4 VRRP virtual routers to the same interface. FortiGates can also be
quickly and easily integrated into a network that has already deployed a group of routers using VRRP.

Example VRRP configuration

The most common application of VRRP is to provide redundant default routers between an internal network and
the internet. The default routers can be FortiGates and or any routers that support VRRP.

To set up VRRP:

1. Add a virtual VRRP router to the internal interface of each of the FortiGates and routers. This adds the FortiGates
and routers to the same VRRP domain.

2. Set the VRRP IP address of the domain to the internal network default gateway IP address.
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3. Give one of the VRRP domain members the highest priority so it becomes the primary (or master) router and give
the others lower priorities so they become backup routers.

During normal operations, all traffic from the internal network to the internet passes through the primary VRRP
router. The primary router also sends VRRP advertisement messages to the backup routers. A backup router will
not attempt to become a primary router while receiving these messages. If the primary router fails, the backup
router with the highest priority becomes the new primary router after a short delay. During this delay the new
primary router sends gratuitous ARP packets to the network to map the network's default route IP address to the
new primary router's MAC address. All packets sent to the default route are now sent the new primary router. If
the new primary router is a FortiGate, the network continues to benefit from FortiOS security features. If the new
primary router is just a router, traffic continues to flow, but FortiOS security features are unavailable until the
FortiGate is back on line.

If the backup router is a FortiGate, during a VRRP failover, as the FortiGate begins operating as the new primary
router it will not have session information for all of the failed over in-progress sessions. So it would normally not
be able to forward in-progress session traffic. To resolve this problem, immediately after a failover and for a short
time (called the start time) the FortiGate acting as the new primary router operates with asymmetric routing
enabled. This allows it to re-create all of the in-progress sessions and add them to its session table.

While operating with asymmetric routing enabled, the FortiGate cannot apply security functions. When the start-
time ends the FortiGate disables asymmetric routing and returns to normal operation (including applying security
functions).

During normal operations, all traffic from the internal network to the Internet passes through the primary VRRP
router. The primary router also sends VRRP advertisement messages to the backup routers. A backup router will
not attempt to become a primary router while receiving these messages. If the primary router fails, the backup
router with the highest priority becomes the new primary router after a short delay. During this delay the new
primary router sends gratuitous ARP packets to the network to map the network's default route IP address to the
new primary router's MAC address. All packets sent to the default route are now sent the new primary router. If
the new primary router is a FortiGate, the network continues to benefit from FortiOS security features. If the new
primary router is just a router, traffic continues to flow, but FortiOS security features are unavailable until the
FortiGate is back on line.

If the backup router is a FortiGate, during a VRRP failover, as the FortiGate begins operating as the new primary
router it will not have session information for all of the failed over in-progress sessions. So it would normally not
be able to forward in-progress session traffic. To resolve this problem, immediately after a failover and for a short
time (called the start time) the FortiGate acting as the new primary router operates with asymmetric routing
enabled. This allows it to re-create all of the in-progress sessions and add them to its session table.

While operating with asymmetric routing enabled, the FortiGate cannot apply security functions. When the start-
time ends the FortiGate disables asymmetric routing and returns to normal operation (including applying security
functions).

Configuring VRRP
To configure VRRP you must configure two or more FortiGate interfaces or routers with the same virtual router ID
and IP address. Then these FortiGates or routers can automatically join the same VRRP domain. You must also
assign priorities to each of the FortiGate interfaces or routers in the VRRP domain. One of the FortiGate
interfaces or routers must have the highest priority to become the primary (or master) router. The other
FortiGates or routers in the domain are assigned lower priorities and become backups. All of the routers in the
VRRP domain should have different priorities. If the primary router fails, VRRP automatically fails over to the
router in the domain with the next highest priority.
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You configure VRRP from the FortiGate CLI by adding a VRRP virtual router to a FortiGate interface. You can
add VRRP virtual routers to multiple FortiGate interfaces and you can add more than one virtual router to the
same interface.

Adding a VRRP virtual router to a FortiGate interface
Use the following command to add an IPv4 VRRP virtual router to the port10 interface of a FortiGate. This VRRP
virtual router has a virtual router ID of 200, uses IP address 10.31.101.200 and has a priority of 255. Since this is
the highest priority, this interface is configured to be the primary router of the VRRP domain with ID number 200.

VRRP can be configured only on physical interfaces or VLAN interfaces. You cannot
configure VRRP on hardware-switch interfaces where multiple physical interfaces are
combined into a hardware switch interface.

config system interface
edit port10

config vrrp
edit 200

set vrip 10.31.101.200
set priority 255

end
end

Setting up VRRP failover
VRRP routers in a VRRP domain periodically send VRRP advertisement messages to all of the routers in the
domain to maintain one router as the primary router and the others as backup routers. The primary router is the
one with the highest priority. If the backup routers stop receiving these packets from the primary router, the
backup router with the highest priority becomes the new primary router.

The primary router stops sending VRRP advertisement messages if it either fails or becomes disconnected. You
can also configure VRRP destination addresses that the primary router monitors. If the primary router becomes
unable to connect to these destination addresses, it stops sending VRRP advertisement messages and the
backup router with the highest priority becomes the primary router. You can add one or two destination addresses
to a VRRP configuration. To be most effective, these destination addresses should be remote addresses.

For example, configure IPv4 VRRP on port14 with two destination address:

config system interface
edit port14

config vrrp
edit 12

set vrdst 10.10.10.20 10.20.20.10
end

Configure IPv6 VRRP on port23 with one destination address:

config system interface
edit port23

config ipv6
config vrrp6

edit 223
set vrdst 2001:db8:1::12

end
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IPv4 VRRP active failover

You can reduce IPv4 VRRP failover times with the vrdst-priority option. This option causes the primary
router to actively signal to the backup routers when the primary router can't reach its configured destination
address or addresses. The primary router does this by sending a lower priority for itself in the VRRP
advertisement messages. You set this lower priority with the vrdst-priority option. The backup router with
the highest priority becomes the new primary router and takes over processing traffic.

The following example configures the primary router to have a priority of 255 so it should always become the
primary router. The command also sets vrdst-priority to 10. So if the primary router can no longer connect
to its destination address of 10.10.10.1, the primary router informs the VRRP group that its priority is now 10.

config system interface
edit port10

config vrrp
edit 12

set vrip 10.31.101.200
set priority 255
set vrdst 10.10.10.1
set vrdst-priority 10

end

Failover of IPv4 firewall VIPs and IP Pools

FortiOS VRRP supports failover of firewall VIPs and IP Pools when the status of a router changes. This feature
introduces a new proxy ARP setting to map VIP and IP Pool address ranges to each router's Virtual MAC (VMAC).
After failover, the IP ranges added to the new primary router are routed to the new primary router's VMAC.

Use the following command to add a proxy ARP address range and a single IP address to a router added to a
FortiGate`s port5 interface. The address range and single IP address should match the address range or single IP
for VIPs or IP pools added to the port5 interface:

config system interface
edit port5

config vrrp
edit 1

config proxy-arp
edit 1

set ip 192.168.62.100-192.168.62.200
next
edit 2

set ip 192.168.62.225
end

Changing the advertisement message interval

By default, VRRP advertisement messages are sent once a second. You can use the following command to
change the frequency of sending these messages. The range is 1 to 255 seconds.

For example, configure an IPv4 VRRP to send advertisement messages every 10 seconds:

config system interface
edit port14

config vrrp
edit 12

set adv-interval 10
end
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Configure IPv6 VRRP to send advertisement messages every 20 seconds:

config system interface
edit port23

config ipv6
config vrrp6

edit 223
set adv-interval 20

end

Changing how long backup routers wait before assuming the primary router has failed

The VRRP startup time is the maximum time that a backup router waits between receiving advertisement
messages from the primary router. If the backup router has to wait longer than the start-time, it assumes the
primary router has failed and becomes the new primary router.

The default startup time is 3 seconds and the range is 1 to 255 seconds.

In some cases the advertisement messages may be delayed. For example, some switches with spanning tree
enabled may delay some of the advertisement message packets. If you find that backup routers are attempting to
become primary routers even though the primary router hasn't failed, you can extend the start time to make sure
the backup routers wait long enough for the advertisement messages.

For example, set the IPv4 VRRP startup time to 10 seconds:

config system interface
edit port14

config vrrp
edit 12

set start-time 10
end

Configure set the IPv6 VRRP startup time to 15 seconds:

config system interface
edit port23

config ipv6
config vrrp6

edit 223
set start-time 15

end

Setting up VRRP groups
If you have added VRRP routers to multiple interfaces of the same FortiGate, each of those routers will be in a
different VRRP domain. If one of these routers switches to backup (for example, if it can't connect to its
destination), you might want all of the routers on this FortiGate to also switch to backup. If other words, if one of
the VRRP routers added to a FortiGate fails, you might want all of the VRRP routers added the FortiGate to also
fail.

However, VRRP can only check the status of the routers in a single VRRP domain and can't track the status of
routers in other domains. So, if you have multiple VRRP domains on a single FortiGate, one of them can switch
to backup but the others can remain operating normally.

VRRP groups allow you to avoid this problem. You can add all of the VRRP virtual routers on the same FortiGate
to a VRRP group. If one of the virtual routers in a VRRP group switches to backup, the VRRP group forces all of
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the other virtual routers in the same group to also switch to backup. So all VRRP traffic being processed by the
FortiGate fails over to other devices in your network.

The status of the virtual routers in a VRRP group can only change when one or more of
the virtual routers in the group changes status. You cannot use a VRRP group to
manually change the status of the virtual routers in the group.

Use the following command to add two VRRP routers to a VRRP group with a group ID of 10. The VRRP group ID
can be between 1 and 65535.

config system interface
edit port10

config vrrp
edit 200

set vrip 10.31.101.200
set priority 255
set vrpgrp 10

end
end

edit port20
config vrrp
edit 100

set vrip 10.23.1.223
set priority 20
set vrpgrp 10

end

Using VRRP virtual MAC addresses
The VRRP virtual MAC address (or virtual router MAC address) is a shared MAC address adopted by the primary
router. If the primary router fails, the same virtual MAC address is picked up by the new primary router allowing all
devices on the network to transparently connect to the default route using the same virtual MAC address. You
must enable the VRRP virtual MAC address feature on all members of a VRRP domain.

Each VRRP router is associated with its own virtual MAC address. The last part of the virtual MAC depends on the
VRRP virtual router ID using the following format:

00-00-5E-00-01-<VRID_hex>

Where <VRID_hex> is the VRRP virtual router ID in hexadecimal format in Internet standard bit-order. For more
information about the format of the virtual MAC see RFC 3768.

Some examples:

l If the VRRP virtual router ID is 10 the virtual MAC would be 00-00-5E-00-01-0a.
l If the VRRP virtual router ID is 200 the virtual MAC would be 00-00-5E-00-01-c8.

The VRRP virtual MAC address feature is disabled by default. When you enable the feature on a FortiGate
interface, all of the VRRP routers added to that interface use their own VRRP virtual MAC address. Each virtual
MAC address will be different because each virtual router has its own ID.

Use the following command to enable the VRRP virtual MAC address for an IPv4 VRRP configuration on the
port2 interface:

config system interface
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edit port2
set vrrp-virtual-mac enable

end
end

The port2 interface will now accept packets sent to the MAC addresses of the IPv4 VRRP virtual routers added to
this interface.

Since devices on the LAN do not have to learn a new MAC address for a new VRRP router in the event of a
failover, this feature can improve network efficiency, especially on large and complex networks.

If the VRRP virtual MAC address feature is disabled, the VRRP domain uses the MAC address of the master. In
the case of a FortiGate VRRP virtual router this is the MAC address of the FortiGate interface that the VRRP
virtual routers are added to. If a master fails, when the new master takes over it sends gratuitous ARPs to
associate the VRRP virtual router IP address with the MAC address of the new master (or the interface of the
FortiGate that has become the new master). If the VRRP virtual MAC address is enabled the new master uses
the same MAC address as the old master.

Example VRRP configuration: two FortiGates in a VRRP domain
This example includes a VRRP domain consisting of two FortiGates that connect an internal network to the
Internet. As shown below, the internal network’s default route is 10.31.101.120.

The FortiGate port2 interfaces connect to the internal network. A VRRP virtual router is added to each FortiGate’s
port2 interface. The virtual router IP address is 10.31.101.120 (the internal network’s default route) and the virtual
router’s ID is 5. The VRRP priority of the primary router is set to 255 and the VRRP priority of the backup router is
50. The port2 interface of each FortiGate should have an IP address that is different from the virtual router IP
address and the port2 interface IP addresses should be different from each other.

This example also includes enabling the VRRP virtual MAC address on both FortiGate port2 interfaces so that the
VRRP domain uses the VRRP virtual MAC address.
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Example VRRP configuration with two FortiGates

To configure the FortiGates for VRRP

1. Select one of the FortiGates to be the primary VRRP router and the other to be the backup router.
2. From the primary router CLI, enter the following command to enable the VRRP virtual MAC address on the port2

interface and add the VRRP virtual router to the port2 interface:
config system interface

edit port2
set vrrp-virtual-mac enable

config vrrp
edit 5

set vrip 10.31.101.120
set priority 255

end
end

3. From the backup router CLI, enter the following command to enable the VRRP virtual MAC address on the port2
interface and add the VRRP virtual router to the port2 interface:

config system interface
edit port2

set vrrp-virtual-mac enable
config vrrp

edit 5
set vrip 10.31.101.120
set priority 50

end
end
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Example VRRP configuration: VRRP load balancing two FortiGates and two VRRP groups
In this configuration two VRRP groups are involved. Each FortiGate participates in both of them. One FortiGate is
the primary router of one group and the other FortiGate is the primary router of the other group. The network
distributes traffic between two different default routes (10.31.101.120 and 10.31.101.130). One VRRP group is
configured with one of the default route IP addresses and the other VRRP group gets the other default route IP
address. During normal operation, both FortiGates are processing traffic and the VRRP groups are used to load
balance the traffic between the two FortiGates.

If one of the FortiGates fails, the remaining FortiGate becomes the primary router of both VRRP groups. The
network sends all traffic for both default routes to this FortiGate. The result is a configuration that, under normal
operation load, balances traffic between two FortiGates, but if one of the FortiGates fails, all traffic fails over to
the FortiGate that is still operating.

This example also includes enabling the VRRP virtual MAC address on both FortiGate port2 interfaces so that the
VRRP groups use their VRRP virtual MAC addresses.

Example VRRP configuration with two FortiGates and two VRRP groups

To configure the FortiGates

1. Log into the CLI of FortiGate A.
2. Enter the following to enable the VRRP virtual MAC address feature and add the VRRP groups to the port2

interface of FortiGate A:
config system interface

edit port2
set vrrp-virtual-mac enable
config vrrp

edit 50 (32)
set vrip 10.31.101.120

1988 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 15 - High Availability VRRP high availability

set priority 255
next
edit 100 (64)

set vrip 10.31.101.130
set priority 50

end
end

3. Log into the CLI of FortiGate B.
4. Enter the following command to enable the VRRP virtual MAC address feature and add the VRRP groups to the

port2 interface of FortiGate B:
config system interface

edit port2
set vrrp-virtual-mac enable
config vrrp

edit 50
set vrip 10.31.101.120
set priority 50

next
edit 100

set vrip 10.31.101.130
set priority 255

end
end

Optional VRRP configuration settings
In addition to the basic configuration settings, you can change to the VRRP configuration in the following ways.
All of these options apply to both IPv4 and IPv6 VRRP unless noted.

l Enable or disable individual virtual router configurations using the status option. Normally virtual router
configurations are enabled but you can temporarily disable one if it is not required.

l Enable or disable preempt mode using the preempt option. In preempt mode, a higher priority backup router can
preempt a lower priority primary router. This can happen if the primary router has failed, a backup router has
become the primary router, and the failed primary router restarts. Since the restarted router has a higher priority, if
preempt mode is enabled the restarted router replaces the current primary router becoming the new primary router.
Preempt mode is enabled by default.

l You can add one or two destination addresses (vrdst) to a VRRP configuration. To be most effective, these
destination addresses should be remote addresses.

FortiGate-6000 and FortiController-5000 support for VRRP HA
FortiGate-6000 devices and FortiController-5000 Session Aware Load Balancing Clustering (SLBC) both support
the Virtual Router Redundancy Protocol (VRRP). You can add FortiGate-6000 devices and FortiController-5000
SLBC configurations to VRRP clusters. These VRRP clusters can include redundant similar hardware platforms or
a variety of routers as long as they all support VRRP..

Configure VRRP on a FortiGate-6000 devices or a FortiController-5000 by creating a VRRP domain and adding
one or more FortiGate-6000 or FortiController front panel interfaces to the domain.

Just like any VRRP domain, during normal operation, the primary router sends outgoing VRRP routing
advertisements. Both the primary and backup routers listen for incoming VRRP advertisements from other routers
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in the VRRP domain. If the primary router fails, the new primary router takes over the role of both sending and
receiving VRRP advertisements.
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In a network that already includes load balancing (either with load balancers or routers) for traffic redundancy, two
or more FortiGates can be integrated into the load balancing configuration using the FortiGate Session Life
Support Protocol (FGSP). The external load balancers or routers can distribute sessions among the FortiGates
and the FGSP performs session synchronization of IPv4 and IPv6 TCP, SCTP, UDP, ICMP, expectation, and
NAT sessions and IPsec tunnels to keep the session tables of the FortiGates synchronized. If one of the
FortiGates fails, session failover occurs and active sessions fail over to the FortiGates that are still operating.
This failover occurs without any loss of data. As well, the external routers or load balancers will detect the failover
and re-distribute all sessions to the peers that are still operating.

The FortiGates operate as peers that process traffic and synchronize sessions with other FortiGates in the
cluster. An FGSP cluster can include from 2 to 16 FortiGates. Adding more FortiGates increases the CPU and
memory required to keep all of the FortiGates synchronized. So depending on your network conditions, adding
too many FortiGates to an FGSP cluster may reduce overall performance.

The FortiGates in the FGSP cluster must be the same model and be running the same firmware version. You use
the config system cluster-sync command to configure FGSP between the FortiGates and the config
system ha command to configure what is synchronized.

In previous versions of FortiOS the FGSPwas called TCP session synchronization or
standalone session synchronization. The FGSP has been expanded to include
configuration synchronization and session synchronization of connectionless sessions,
expectation sessions, and NAT sessions and IPsec tunnels.

The FGSP can be used instead of FGCPHA to provide session synchronization between two peer FortiGates.
If the external load balancers direct all sessions to one peer the affect is similar to active-passive FGCPHA. If
external load balancers or routers load balance traffic to both peers, the effect is similar to active-active FGCP
HA. The load balancers should be configured so that all of the packets for any given session are processed by the
same peer. This includes return packets.
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FGSP HA

By default, FGSP synchronizes all IPv4 and IPv6 TCP sessions, IPsec tunnels, and also synchronizes the
configuration of the FortiGates.

You can optionally enable session pickup to synchronize connectionless (UDP and ICMP) sessions, expectation
sessions, and NAT sessions. If you do not enable session pickup, the FGSP does not share session tables for the
particular session type and sessions do not resume after a failover. All sessions are interrupted by the failover and
must be re-established at the application level. Many protocols can successfully restart sessions with little, or no,
loss of data. Others may not recover easily. Enable session pickup for sessions that may be difficult to
reestablish. Since session pickup requires FortiGate memory and CPU resources, only enable this feature for
sessions that you need to have synchronized.

The synchronization link is set up in the same way as FGCP heartbeat interfaces. You must connect the
synchronization link interfaces together and use the heartbeat device (hbdev) option to add the heartbeat devices
to the configuration.

You can also optionally add filters to control which sessions are synchronized. You can add filters to only
synchronize packets from specified source and destination addresses, specified source and destination
interfaces, and specified services.

Load balancing and session failover is done by external routers or load balancers instead of by the FGSP. The
FortiGates only perform session synchronization to support session failover as well as configuration
synchronization.
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Configuring FGSP HA cluster-sync instances
You use the following command to configure an FGSPHA cluster-sync instance.

config system cluster-sync
edit 1

set peerip <peer-ip-address>
set peervd <vdom-name>
set syncvd <vdom-name>

end

Where:

l peerip is the IP address of an interface of another FortiGate in the FGSP cluster that this configuration
synchronizes sessions to.

l peervd the name of the virtual domain that contains the session synchronization link interface on the peer unit.
Usually both peers would have the same peervd. Multiple session synchronization configurations can use the same
peervd. The default VDOM name is root.

l syncvd is the name of one or more VDOMs that should be synchronized by this cluster-sync instance. If multiple
VDOMs are not enabled, syncvd should be set to root, which is the default setting.

For FGSPHA to work properly, all VDOMs to be synchronized must be added to all of
the FortiGates in cluster. The names of the matching interfaces in each VDOM must
also be the same; this includes the names of matching VLAN interfaces. Note that the
index numbers of the matching interfaces and VLAN interfaces can be different. Also
the VLAN IDs of the matching VLAN interfaces can be different. If you enable
configuration synchronization this will happen automatically.

This command creates a cluster-sync instance that causes a FortiGate to synchronize the TCP sessions of one of
its VDOMs (by default the root VDOM) to the root VDOM of another FortiGate (which would become another
FortiGate in the FGSP cluster). You can also use the config system ha command to synchronize more
session types and to synchronize the configuration. Cluster-sync instances are not synchronized and must be
added to each FortiGate in the cluster.

A cluster of two FortiGates would only require one cluster-sync instance for each VDOM to be synchronized.
This instance would synchronize the sessions from the root VDOM of one FortiGate to the root VDOM of the
other. The second FortiGate would also include a cluster-sync instance to synchronize its root VDOM with the
other FortiGate's root VDOM.

In a multiple VDOM configuration, you add a separate cluster-sync instance for each VDOM to be synchronized.
You don’t have to synchronize all VDOMs. If multiple VDOMs are enabled, the config system cluster-
sync command is a global command.

FGSP clusters with three or more FortiGates

If an FGSP cluster includes three or more FortiGates you must explicitly define all of the cluster-sync instances
that you need. In a cluster of four FortiGates, each FortiGate can synchronized with up to three other FortiGates.
So, to synchronize all of the FortiGates, you must add three cluster-sync instances to each FortiGate (or n-1,
where n is the number of FortiGates in the cluster).
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Selecting the sessions to synchronize

You can add a cluster-sync instance with a filter to only synchronize some sessions. A filter can be added to a
cluster-sync instance as follows:

config system cluster-sync
edit 1

set peerip <peer-ip-address>
set peervd <vdom-name>
set syncvd <vdom-name>

config session-sync-filter
srcintf <interface-name>
dstintf <interface-name>
srcaddr x.x.x.x x.x.x.x
dstaddr x.x.x.x x.x.x.x
srcaddr6 ::/x
dstaddr6 ::/x

end
end

You can use the filter to only synchronize sessions according to the session source and destination interface and
IPv4 to IPv6 address.

You can only add one filter to a cluster-sync instance. To create multiple filters you must create multiple cluster-
sync instances.

Synchronizing TCP and SCTP sessions
Use the following to enable session synchronization for TCP and SCTP sessions and to configure the FGSP to
use the port8 interface for synchronizing traffic:

config system ha
set session-pickup enable
set hbdev "port8" 50

end

Automatic session sync after peer reboot

You can configure your FGSP cluster to resume sessions more smoothly after a failed FortiGate rejoins the
cluster. In some cases when a failed FortiGate in the cluster comes back up it may begin processing sessions
before the session table from the other FortiGate in the cluster has been synchronized to it. When this happens,
the FortiGate may drop packets until the session synchronization is complete.

Shutting down interfaces during session synchronization

This feature allows you to shut down some interfaces on the failed FortiGate when it is starting up so that it will
not accept packets until session synchronization is complete. Then the interfaces are brought up and traffic can
flow. While the interfaces are down, the FortiGate that had not failed keeps processing traffic.

Use the following to select the interfaces to shutdown while waiting for session synchronization to complete:

config system cluster-sync
edit 1

set down-intfs-before-sess-sync port1 port2
end
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Heartbeat monitoring

If the FortiGate that was running fails before session synchronization is complete, the FortiGate that is restarting
will not be able to complete session synchronization and will not turn on its shutdown interfaces. To prevent this
from happening, FGSP includes heartbeat monitoring. Using heartbeat monitoring, the FortiGate that is waiting
for session synchronization to finish can detect that the other FortiGate is down and turn on its interfaces even if
session synchronization is not complete. You can use the following to change the heartbeat interval (hb-
interval) and lost heartbeat threshold (hp-lost-threshold) to change heartbeat monitoring timing.

config system cluster-sync
edit 1

set hb-interval 2
set hb-lost-threshold 3

end

Synchronizing the configuration
The FGSP includes configuration synchronization, allowing you to make configuration changes once for all of the
FortiGates in the cluster, instead of requiring you to make redundant configuration changes on each FortiGate.

By default, configuration synchronization is disabled. You can enter the following to enable it:

config system ha
set standalone-config-sync enable

end

You must enter this command on all of the FortiGates in the FGSP cluster. When you enable synchronizing the
configuration, the FGSP uses FGCP primary unit selection to select a config sync primary (or master) FortiGate.
The other FortiGates in the FGSP cluster become config sync backup FortiGates. The FGSP synchronizes all
configuration changes that you make on the config sync primary FortiGate to the config sync backup FortiGates.
Fortinet recommends making all configuration changes on the config sync primary FortiGate.

Config sync primary FortiGate selection

The FGSP cluster uses FGCP primary unit selection to select the FGSP config sync primary FortiGate (see
Primary unit selection on page 1744). So normally, the FortiGate with the highest serial number would become
the primary FortiGate.

You can use device priority select one of the FortiGates to become the config sync primary FortiGate. For
example, the following command enables configuration synchronization on a FortiGate and sets a higher device
priority than the default of 128 to make sure that this FortiGate becomes the primary FortiGate.

config system ha
set standalone-config-sync enable
set priority 250

end

Settings that are not synchronized

FGSP configuration synchronization does not synchronize settings that identify the FortiGate to the network. The
following settings are not synchronized:

l Transparent mode management IPv4 and IPv6 IP addresses and default gateways.
l All config system cluster-sync settings.
l All config system interface settings except vdom, vlanid, type and interface.
l All config firewall sniffer settings.
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l All router BFD and BFD6 settings.
l The following BGP settings: as, router-id, aggregate-address, aggregate-address6, neighbor-
group, neighbor, network, and network6.

l The following OSPF settings: router-id, area, ospf-interface, network, neighbor, and summary-
address.

l The following OSPF6 settings: router-id, area, and ospf6-interface.
l All RIP settings.
l All policy routing settings.
l All static routing settings.

Backing up and restoring the configuration of FGSP cluster members

You should maintain separate backup configuration files for each FortiGate in the FGSP cluster. Separate
configuration files are required because not all settings are synchronized.

Restoring the configuration of one cluster member from a configuration file does not affect the configurations of
other FortiGates in the cluster. You should restore each cluster member separately with its own configuration file.

FGSP and firmware upgrades
The steps to follow to upgrade the firmware running on an FGSP cluster depend on whether you have enabled
configuration synchronization (Synchronizing the configuration on page 1995) or not:

l If you have not enabled configuration synchronization, you must upgrade the firmware separately on each
FortiGate in the cluster. Upgrading the firmware of each FortiGate interrupts traffic though that FortiGate.

l If you have enabled configuration synchronization, you can upgrade the cluster firmware by upgrading the firmware
running on the sync primary FortiGate. The FGSP then sends the new firmware image to the config sync backup
FortiGates and all of the FortiGates in cluster install the new firmware and restart. The firmware upgrade
simultaneously interrupts traffic through all of the FortiGates in the cluster.

FGSP firmware upgrade best practice

Fortinet recommends using the following steps to upgrade the firmware of the FortiGates in an FGSP cluster.
Follow these steps whether or not you have enabled configuration synchronization.

For an example FGSP cluster of two FortiGates (FGT-1 and FGT-2):

1. Switch all traffic to FGT-1.
Configure the load balancer or router that distributes traffic between the FortiGates to send all traffic to one of the
FortiGates in the FGSP cluster (in this case FGT-1).

2. Disconnect FGT-2 from your network.
Make sure to also disconnect the interfaces that allow heartbeat and synchronization communication with FGT-1.
You want to prevent FGT-2 from communicating with FGT-1.

3. Upgrade the firmware of FGT-2.
4. Re-connect FGT-2's traffic interfaces (but not the interfaces used for heartbeat and synchronization

communication with FGT-1).
5. Switch all traffic to the newly upgraded FGT-2.

Configure the load balancer or router that distributes traffic between the FortiGates to send all traffic to the
FortiGate with upgraded firmware.

6. Upgrade the firmware of FGT-1 (while heartbeat and synchronization communication with FGT-2 remains
disconnected).
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7. Re-connect the FGT-2 interfaces that allow heartbeat and synchronization communication between FGT-1 and
FGT-2.

8. Restore the original traffic distribution between FGT-1 and FGT-2.
Configure the load balancer or router to again distribute traffic to both FortiGates in the FGSP cluster.

Backing up and restoring the configuration of an FGSP cluster
You should maintain separate backup configuration files for each FortiGate in the FGSP cluster. When you
restore the configuration of one of the FortiGates in an FGSP cluster, the FGSP does not synchronize the
configuration file to the other FortiGates in the FGSP cluster. Instead you must back up each FortiGate
separately and restore the configuration of each FortiGate separately with its own configuration file.

IPsec tunnel synchronization
When you use the config system cluster-sync command to enable FGSP, IPsec keys and other
runtime data (but not actual tunnel sessions) are synchronized between cluster units . This means that if one of
the cluster units goes down, the cluster units that are still operating can quickly get IPsec tunnels re-established
without re-negotiating them. However, after a failover, all existing tunnel sessions on the failed FortiGate have to
be restarted on the FortiGates that are still operating.

IPsec tunnel sync supports both static and dialup IPsec tunnels. For IPsec tunnel synchronization to work, the
interfaces on the FortiGates that are tunnel endpoints must have the same IP addresses and external routers
must be configured to load balance IPsec tunnel sessions to the FortiGates in the cluster.

Optionally synchronizing IKE routes

You can use the following command to control whether IKE routes are synchronized to all units in the FGSP
cluster.

config system cluster-sync
edit 0

set slave-add-ike-routes {enable | disable}
end

Enable to synchronize IKE routes, disable if you do not need to synchronize IKE routes. Enabling routing
synchronization is optional but doing so increases synchronization overhead and bandwidth usage. If you have
problems with IPsec VPN tunnel synchronization, you may want to enable synchronizing routes. Otherwise you
could leave it disabled to improve performance and save bandwidth.

Synchronizing UDP and ICMP (connectionless) sessions
In many configurations, due to their non-stateful nature, UDP and ICMP sessions don't need to be synchronized
to naturally failover. However, if required you can configure the FGSP to synchronize UDP and ICMP sessions by
entering the following:

config system ha
set session-pickup enable
set session-pickup-connectionless enable

end
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Synchronizing NAT sessions
By default, NAT sessions are not synchronized. However, the FGSP can synchronize NAT sessions if you enter
the following:

config system ha
set session-pickup enable
set session-pickup-nat enable

end

However, if you want NAT sessions to resume after a failover, you should not configure NAT to use the
destination interface IP address since the FGSP FortiGates have different IP addresses. With this configuration,
after a failover all sessions that include the IP addresses of interfaces on the failed FortiGate will have nowhere to
go since the IP addresses of the failed FortiGate will no longer be on the network.

Instead, in an FGSP configuration, if you want NAT sessions to failover, you should use IP pools with the type set
to overload (which is the default IP pool type). For example:

config firewall ippool
edit FGSP-pool

set type overload
set startip 172.20.120.10
set endip 172.20.120.20

end

Then when you configure NAT firewall policies, turn on NAT and select to use dynamic IP pool and select the IP
pool that you added. Configuration synchronization should add the same IP pools and firewall policies to all
FortiGates in the cluster. If configuration synchronization is not enabled you must add the same IP pools and
policies to all of the FortiGates in the cluster.

Synchronizing asymmetric sessions
By default, asymmetric sessions are not synchronized. Normally, session synchronization cannot be asymmetric
because it is stateful. So all of the packets of a given session must be processed on the same FortiGate. This
includes return packets.

However, if you have an asymmetric routing configuration, you can enter the following command to synchronize
asymmetric sessions by dynamically detecting asymmetric sessions and disabling anti-reply for these sessions.

config system ha
set session-pickup enable
set session-pickup-expectation enable

end

The FGSP enforces firewall policies for asymmetric traffic, including cases where the TCP 3-way handshake is
split between two FortiGates. For example, FGT-A receives the TCP-SYN, FGT-B receives the TCP-SYN-ACK,
and FGT-A receives the TCP-ACK. Under normal conditions, a firewall will drop this connection since the 3-way
handshake was not seen by the same firewall. However, two FortiGates with FGSP configured will be able to
properly pass this traffic since the firewall sessions are synchronized.

This asymmetric function can also work with connectionless UDP and ICMP traffic. If traffic will be highly
asymmetric, as described above, the following command must be enabled on both FortiGates.

config system ha
set session-pickup enable
set session-pickup-connectionless enable

end
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Synchronizing asymmetric traffic can be very useful in situations where multiple Internet connections from
different ISPs are spread across multiple FortiGates. Since it is typically not possible to guarantee Internet-bound
traffic leaving via an ISP will return using the exact same ISP, the FGSP provides critical firewall functions in this
situation.

Asymmetric sessions may not be synchronized in low latency networks if the reply
packet is received before the peer has received the session synchronization packet.
This limitation usually only occurs in low latency networks.

The FGSP also has applications in virtualized computing environments where virtualized hosts move between
data centers. The firewall session synchronization features of FGSP allow for more flexibility than in traditional
firewalling functions.

Synchronizing expectation sessions
FortiOS session helpers keep track of the communication of Layer-7 protocols such as FTP and SIP that have
control sessions and expectation sessions. Usually the control sessions establish the link between server and
client and negotiate the ports and protocols that will be used for data communications. The session helpers then
create expectation sessions through the FortiGate for the ports and protocols negotiated by the control session.

The expectation sessions are usually the sessions that actually communicate data. For FTP, the expectation
sessions transmit files being uploaded or downloaded. For SIP, the expectation sessions transmit voice and video
data. Expectation sessions usually have a timeout value of 30 seconds. If the communication from the server is
not initiated within 30 seconds, the expectation session times out and traffic will be denied.

By default the FGSP does not synchronize expectation sessions and if a failover occurs, the sessions will have to
be restarted.

If you want to synchronize expectation sessions so that they will continue after a failover, you can enter the
following:

config system ha
set session-pickup enable
set session-pickup-expectation enable

end

Security profile flow-based inspection and asymmetric traffic
Security profile inspection (flow- or proxy-based) for a session is not expected to work properly if the traffic in the
session is balanced across more than one FortiGate in either direction. Flow-based inspection should be used in
FGSP deployments.

For an environment where traffic is symmetric, security profile inspection can be used with the following
limitations:

l No session synchronization for the sessions inspected using proxy-based inspection. Sessions will drop and need to
be reestablished after data path failover.

l Sessions with flow-based inspection will failover; however, inspection of failed over sessions after the failover may
not work.

A single FortiGate must see both the request and reply traffic for security profile inspection to function correctly.
For environments where asymmetric traffic is expected, security profile inspection should not be used.
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Notes and limitations
FGSPHA has the following limitations:

l The FGSP is a global configuration option. As a result you can only add one service to a filter configuration. You
cannot add custom services or service groups even if virtual domains are not enabled.

l You can only add one filter configuration to a given FGSP configuration. However, you can add multiple filters by
adding multiple identical FGSP configurations, each one with a different filter configuration.

l Sessions accepted by security policies with security profiles configured are not synchronized.
l FGSPHA is configured from the CLI.
l FGSPHA is available for FortiGates or virtual domains operating in NAT or transparent mode. NAT sessions are not

synchronized in either mode (unless NAT synchronization is enabled as described in Synchronizing NAT sessions on
page 1998). In NAT mode, only sessions for route mode security policies are synchronized. In transparent mode,
only sessions for normal transparent mode policies are synchronized.

l FGSPHA is supported for traffic on physical interfaces, VLAN interfaces, zones, aggregate interfaces, and NPx
(NP4, NP6 etc.) accelerated interfaces. The FGSP has not been tested for inter-vdom links, between HA clusters,
and for redundant interfaces.

l The names of the matching interfaces, including VLAN interfaces, aggregate interfaces and so on, must be the
same on both peers.

l An FGSP cluster can include from 2 to 16 FortiGates. Adding more FortiGates increases the CPU and memory
required to keep all of the FortiGates synchronized.

Configuring session synchronization links
When FGSPHA is operating, the FortiGates share session information over Ethernet links similar to an HA
heartbeat link. Usually you would use the same interface on each FortiGate for session synchronization. If
possible you should connect the session synchronization interfaces directly without using a switch or other
networking equipment. For FortiGate-5000 systems you can use a backplane interface as the session
synchronization link.

You can use different interfaces on each FortiGate for session synchronization links. Also, if you have multiple
session synchronization configurations, you can have multiple links between the FortiGates. In fact if you are
synchronizing a lot of sessions, you may want to configure and connect multiple session synchronization links to
distribute session synchronization traffic to these multiple links.

You cannot configure backup session synchronization links. Each configuration only includes one session
synchronization link.

The session synchronization link should always be maintained. If session synchronization communication is
interrupted and a failure occurs, sessions will not failover and data could be lost.

Session synchronization traffic can use a considerable amount of network bandwidth. If possible, session
synchronization link interfaces should only be used for session synchronization traffic and not for data traffic.

Basic example configuration
The following configuration example shows how to configure basic FGSPHA for the two peer FortiGates shown
below.
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l The host names of peers are peer_1 and peer_2.
l Both peers are configured with two virtual domains: root and vdom_1.
l All sessions processed by vdom_1 are synchronized.
l The synchronization link interface is port3 which is in the root virtual domain.
l The IP address of port3 on peer_1 is 10.10.10.1.
l The IP address of port3 on peer_2 is 10.10.10.2.

Also on both peers, port1 and port2 are added to vdom_1. On peer_1 the IP address of port1 is set to
192.168.20.1 and the IP address of port2 is set to 172.110.20.1. On peer_2 the IP address of port1 is set to
192.168.20.2 and the IP address of port2 is set to 172.110.20.2.

Example FGSP HA network configuration

To configure FGSP HA

1. Configure the load balancer or router to send all sessions to peer_1.
2. Configure the load balancer or router to send all traffic to peer_2 if peer_1 fails.
3. Use normal FortiGate configuration steps on peer_1:

l Enable virtual domain configuration.
l Add the vdom_1 virtual domain.
l Add port1 and port2 to the vdom_1 virtual domain and configure these interfaces.
l Set the IP address of port1 to 192.168.20.1.
l Set the IP address of port2 to 172.110.20.1.
l Set the IP address of port3 to 10.10.10.1.
l Add route mode security policies between port1 and port2 to vdom_1.

4. Enter the following commands to configure session synchronization for peer_1:
config system cluster-sync

edit 1
set peerip 10.10.10.2
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set peervd root
set syncvd vdom_1

end

5. Use normal FortiGate configuration steps on peer_2:
l Enable virtual domain configuration.
l Add the vdom_1 virtual domain.
l Add port1 and port2 to the vdom_1 virtual domain and configure these interfaces.
l Set the IP address of port1 to 192.168.20.2.
l Set the IP address of port2 to 172.110.20.2.
l Set the IP address of port3 to 10.10.10.1.
l Add route mode security policies between port1 and port2 to vdom_1.

6. Enter the following command to configure session synchronization for peer_1
config system cluster-sync

edit 1
set peerip 10.10.10.1
set peervd root
set syncvd vdom_1

end

To synchronize the configuration

Enter the following command on both FortiGates to enable configuration synchronization.

config system ha
set standalone-config-sync enable

end

The configurations of the FortiGates will now be synchronized. When you make a configuration change on one
FortiGate, the change will be synchronized to the other one.

To add filters

You can add a filter to this basic configuration if you only want to synchronize some TCP sessions. For example
you can enter the following command to add a filter so that only HTTP sessions are synchronized:

config system cluster-sync
edit 1

config filter
set service HTTP

end
end

You can also add a filter to control the source and destination addresses of the IPv4 packets that are
synchronized. For example, you can enter the following to add a filter so that only sessions with source addresses
in the range 10.10.10.100 to 10.10.10.200 are synchronized.

config system cluster-sync
edit 1

config filter
set srcaddr 10.10.10.100 10.10.10.200

end
end
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You can also add a filter to control the source and destination addresses of the IPv6 packets that are
synchronized. For example, you can enter the following to add a filter so that only sessions with destination
addresses in the range 2001:db8:0:2::/64 are synchronized.

config system cluster-sync
edit 1

config filter
set dstaddr6 2001:db8:0:2::/64

end
end

To synchronize TCP sessions

You enter the following to synchronizationTCP sessions and set the synchronization link (heartbeat device):

config system ha
set hbdev "port3" 50
set session-pickup enable

end

To synchronize UDP and ICMP sessions

You enter the following to add synchronization of UDP and ICMP sessions to this configuration:

config system ha
set session-pickup enable
set session-pickup-connectionless enable

end

Verifying the FGSP configuration and synchronization
You can use the following diagnose commands to verify that the FGSP and its synchronization functions are
operating correctly.

FGSP configuration summary and status

Enter the following command to display a summary of the FGSP configuration and synchronization status:

diagnose sys session sync
sync_ctx: sync_started=1, sync_tcp=1, sync_others=1,
sync_expectation=1, sync_redir=0, sync_nat=1, stdalone_sessync=0.
sync: create=12:0, update=0, delete=0:0, query=14
recv: create=14:0, update=0, delete=0:0, query=12
ses pkts: send=0, alloc_fail=0, recv=0, recv_err=0 sz_err=0
nCfg_sess_sync_num=5, mtu=16000
sync_filter:
1: vd=0, szone=0, dzone=0, saddr=0.0.0.0:0.0.0.0, daddr=0.0.0.0:0.0.0.0,

sync_started=1 shows that synchronization is working. If this is set to 0 then something is not correct with
session synchronization and synchronization has not been able to start because of it.

sync_tcp=1, sync_others=1, sync_expectation=1, and sync_nat=1 show that the FGSP has been
configured to synchronize TCP, connectionless, asymmetric, and NAT sessions.

sync: create=12:0 and recv: create=14:0 show that this FortiGate has synchronized 12 sessions to
its peer and has received 14 sessions from its peer.
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sync_filter shows the configured FGSP filter. In this case no filter has been created so all sessions are
synchronized.

vd=0 indicates that root VDOM sessions are synchronized.

Verifying that sessions are synchronized

Enter the command diagnose sys session list to display information about the sessions being
processed by the FortiGate. In the command output look for sessions that should be synchronized and make sure
they contain output lines that include synced for example, state=log may_dirty ndr synced) to
confirm that they are being synchronized by the FGSP.

diagnose sys session list
session info: proto=6 proto_state=05 duration=469 expire=0 timeout=3600
flags=00000000 sockflag=00000000 sockport=21 av_idx=0 use=4
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 policy_dir=0 tunnel=/
state=log may_dirty ndr synced
statistic(bytes/packets/allow_err): org=544/9/1 reply=621/7/0 tuples=2
orgin->sink: org pre->post, reply pre->post dev=46->45/45->46
gwy=10.2.2.1/10.1.1.1
hook=pre dir=org act=noop 192.168.1.50:45327->172.16.1.100:21(0.0.0.0:0)
hook=post dir=reply act=noop 172.16.1.100:21->192.168.1.50:45327(0.0.0.0:0)
pos/(before,after) 0/(0,0), 0/(0,0)
misc=0 policy_id=1 id_policy_id=0 auth_info=0 chk_client_info=0 vd=0
serial=00002deb tos=ff/ff ips_view=1 app_list=2000 app=16427
dd_type=0 dd_mode=0
per_ip_bandwidth meter: addr=192.168.1.50, bps=633
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IPsec VPN

This FortiOS Handbook chapter contains the following sections:

IPsec VPN concepts explains the basic concepts that you need to understand about virtual private networks
(VPNs).

IPsec VPN overview provides a brief overview of IPsec technology and includes general information about how to
configure IPsec VPNs using this guide.

IPsec VPN in the web-based manager describes the IPsec VPNmenu of the web-based manager interface.

Gateway-to-gateway configurations explains how to set up a basic gateway-to-gateway (site-to-site) IPsec VPN.
In a gateway-to-gateway configuration, two FortiGate units create a VPN tunnel between two separate private
networks.

Hub-and-spoke configurations describes how to set up hub-and-spoke IPsec VPNs. In a hub-and-spoke
configuration, connections to a number of remote peers and/or clients radiate from a single, central FortiGate
hub.

Dynamic DNS configuration describes how to configure a site-to-site VPN, in which one FortiGate unit has a static
IP address and the other FortiGate unit has a dynamic IP address and a domain name.

FortiClient dialup-client configurations guides you through configuring a FortiClient dialup-client IPsec VPN. In a
FortiClient dialup-client configuration, the FortiGate unit acts as a dialup server and VPN client functionality is
provided by the FortiClient Endpoint Security application installed on a remote host.

FortiGate dialup-client configurations explains how to set up a FortiGate dialup-client IPsec VPN. In a FortiGate
dialup-client configuration, a FortiGate unit with a static IP address acts as a dialup server and a FortiGate unit
with a dynamic IP address initiates a VPN tunnel with the FortiGate dialup server.

Supporting IKEMode config clients explains how to set up a FortiGate unit as either an IKEMode Config server
or client. IKEMode Config is an alternative to DHCP over IPsec.

Internet-browsing configuration explains how to support secure web browsing performed by dialup VPN clients,
and hosts behind a remote VPN peer. Remote users can access the private network behind the local FortiGate
unit and browse the Internet securely. All traffic generated remotely is subject to the security policy that controls
traffic on the private network behind the local FortiGate unit.

Redundant VPN configurations discusses the options for supporting redundant and partially redundant tunnels in
an IPsec VPN configuration. A FortiGate unit can be configured to support redundant tunnels to the same remote
peer if the FortiGate unit has more than one interface to the Internet.

Transparent mode VPNs describes two FortiGate units that create a VPN tunnel between two separate private
networks transparently. In transparent mode, all FortiGate unit interfaces except the management interface are
invisible at the network layer.

IPv6 IPsec VPNs describes FortiGate unit VPN capabilities for networks based on IPv6 addressing. This includes
IPv4-over-IPv6 and IPv6-over-IPv4 tunnelling configurations. IPv6 IPsec VPNs are available in FortiOS 3.0 MR5
and later.
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L2TP and IPsec (Microsoft VPN) explains how to support Microsoft Windows native VPN clients.

GRE over IPsec (Cisco VPN) explains how to interoperate with Cisco VPNs that use Generic Routing
Encapsulation (GRE) protocol with IPsec.

Protecting OSPF with IPsec provides an example of protecting OSPF links with IPsec.

Redundant OSPF routing over IPsec provides an example of redundant secure communication between two
remote networks using an OSPF VPN connection.

OSPF over dynamic IPsec provides an example of how to create a dynamic IPsec VPN tunnel that allows OSPF.

BGP over dynamic IPsec provides an example of how to create a dynamic IPsec VPN tunnel that allows BGP.

Phase 1 parameters provides detailed step-by-step procedures for configuring a FortiGate unit to accept a
connection from a remote peer or dialup client. The basic Phase 1 parameters identify the remote peer or clients
and support authentication through preshared keys or digital certificates. You can increase VPN connection
security further using methods such as extended authentication (XAuth).

Phase 2 parameters provides detailed step-by-step procedures for configuring an IPsec VPN tunnel. During
Phase 2, the specific IPsec security associations needed to implement security services are selected and a tunnel
is established.

Defining VPN security policies explains how to specify the source and destination IP addresses of traffic
transmitted through an IPsec VPN tunnel, and how to define a security encryption policy. Security policies control
all IP traffic passing between a source address and a destination address.

Logging and monitoring and Troubleshooting provide VPNmonitoring and troubleshooting procedures.
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This chapter describes new IPsec VPN features added to FortiOS 5.6.

FortiOS 5.6.4
These features first appeared in FortiOS 5.6.4.

l Updates to "IPsec VPNWizard options" on page 2018

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

IPsec performance improvements for VM (439030)

In IPsec AES-GCM and AES-CBC-SHAmode, this feature leverages Intel AES-NI instructions to accelerate
cipher and GCM operations, and uses Intel SSSE3 instructions to accelerate SHA1/SHA256 HMAC operations.

New entries to call Intel aesni directly:

l supported algorithms include: aesni, aesni-gcm, sha1/256/384/512-ssse3/avx/avx2
l some necessary additions, such as aes-gcm generic functions for non-aesni uses

This feature removes the old aes-gcm implementation using Linux Crypto API so that all the software crypto
algorithms are under the Crypto_ftnt umbrella.

Two new diagnose commands have been introduced in this feature:

diagnose vpn ipsec driver   (shows software crypto drivers in use)
diagnose vpn ipsec cpu (shows crypto CPU distribution)

Improved support for dynamic routing over dynamic IPsec interfaces (435152) (446498)
(447569)

Solutions have been introduced to resolve the following issues:

l IPv6 RIP does not successfully exchange routes over ADVPN if the hub has 'set net-device disable'.
l BGP over an IPsec tunnel established by an IKEmode-cfg client connected to IKEmode-cfg server with 'set net-

device disable' cannot establish.
l Multicast traffic does not flow over a 'set type dynamic' IPsec interface with 'set net-device disable'.

For 'set type dynamic' + 'set net-device disable' + 'set mode-cfg enable' + 'set add-route disable' then do _not_
allocate a /30 (/126 for IPv6) as is done when 'set net-device enable', instead allocate a single IP address to the
peer.

When the 'set type dynamic' tunnel negotiates, then add an IPsec peer route with the peer's allocated IP address
pointing at the newly negotiated tunnel. Note this is an IPsec peer route not a regular route. A regular route is not
added (unlike the case of 'set net-device enable').

'Config router static' / 'set device xxx' can now refer to a 'set type dynamic' IPsec interface. This allows the admin
to define a static route covering the address range of the pool from which peer IP addresses will be allocated.
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BMRK IPsec UDP performance for AES256GCM drops after AES-NI checked in (452164)

This new feature fixes the aesni-cbc errors and precomputed the per-SA constant elements for aesni-gcm.

1. aesni-cbc
When ECO 106922 was checked in, there was a known issue that the aesni-cbc driver wasn't working. The
solution at that time was aesni plus generic cbc.

With this ECO, we fixed the errors in Intel's aesni-cbc driver so that we can fully leverage the aesni-cbc
benefits. The aesni-cbc is faster than aesni plus generic cbc because:

a. it can do cbc in one go with its 128-bits xmm registers.

b. it can decrypt 4 blocks at the same time instead of one. It uses alternating AESDEC(Intel's aes instruction) on
different blocks to speed up the calculations.

QA's tests show that with this, we can boost aes-cbc-sha1's throughput by 10+%.

2. AES fall-back function changed to Intel's x86_64 assembly from C generic function
When fpu is not available, aesni can't be used and must fall back to a generic function. The assembly aes
function should be slightly faster than the C generic one.

This would also slight boost aes throughput for those that don't have aesni but have a x86_64 cpus.

3. aesni-gcm pre-computions
There are some elements in the aesni-gcm algo that maintain constant per-SA. This ECO moves these
calculations to the prepare() function so that these calculations are only done once per-SA instead of per-
packet.

QA's tests show that this helps to stabilize the 1500D aesni-gcm throughput and make it maintain above
1Gbps (packet size 1360).

4. Added counter reset function for diagnose commands:
diagnose vpn ipsec driver clear
diagnose vpn ipsec cpu clear

IPsec dial-up interface sharing (379973)

This feature makes it possible to use a single interface for all instances that spawn via a given phase1. Instead of
creating an interface per instance, all traffic will run over the single interface and any routes that need creating will
be created on that single interface.

A new CLI option "net-device [enable|disable]" is added in the phase1-interface command sets. The
default is "disable" so that the new feature kicks in for all the new configurations. An upgrade feature will add a
"set net-device enable" for all the existing configurations so that they will keep the old behavior. Please see the
CLI Syntax section below for more details.

Under the new single-interface scheme, instead of relying on routing to guide traffic to the specific instance as
currently happens, all traffic will flow to the specific device and IPsec will need to take care of locating the correct
instance for outbound traffic. For this purpose, another new CLI option "tunnel-search" is created. The option is
only available when the above "net-device" option is "disable".

There are two options for "tunnel-search", corresponding to the two ways to select the tunnel for outbound traffic.
One is "selectors", meaning selecting a peer using the IPSec selectors (proxy-ids). The other is "nexthop" where
all the peers use the same default selectors (0/0) while using some routing protocols such as BGP, OSPF, RIPng,
etc to resolve the routing. The default for "tunnel-search" is "selectors".
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Syntax

config vpn ipsec phase1-interface
edit xxx

set net-device [enable|disable] Enable to create a kernel device for every dialup instance
next

end
config vpn ipsec phase1-interface

edit xxx
set net-device disable
set tunnel-search [selectors|nexthop] Search for tunnel in selectors or using nexthops

next
end

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

Support for Brainpool curves specified in RFC 6954 for IKE (412795)

Added support for Brainpool curves specified in RFC 6954 (originally RFC 5639) for IKE. Four new values are
added for VPN phase1 and phase2 DH groups.

The allocated transform IDs are 27, 28, 29, 30:

l 27 - Brainpool 224-Bit Curve
l 28 - Brainpool 256-Bit Curve
l 29 - Brainpool 384-Bit Curve
l 30 - Brainpool 512-Bit Curve

Syntax

config vpn ipsec phase1/phase1-interface
edit <name>

set dhgrp {1 | 2 | 5 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 27 | 28 | 29 | 30}
next

end
config vpn ipsec phase2/phase2-interface

edit <name>
set dhgrp {1 | 2 | 5 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 27 | 28 | 29 | 30}

next
end

Removed "exchange-interface-ip" option from "vpn ipsec phase1" (411981)

The command exchange-interface-ip only works for interface-based IPsec VPN (vpn ipsec phase1-
interface), and so it has been removed from policy-based IPsec VPN (vpn ipsec phase1).

IKEv2 ancillary RADIUS group authentication (406497)

This feature provides for the IDi information to be extracted from the IKEv2 AUTH exchange and sent to a
RADIUS server, along with a fixed password configurable via CLI, to perform an additional group authentication
step prior to tunnel establishment. The RADIUS server may return framed-IP-address, framed-ip-netmask, and
dns-server attributes, which are then applied to the tunnel.
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It should be noted, unlike Xauth or EAP, this feature does not perform individual user authentication, but rather
treats all users on the gateway as a single group, and authenticates that group with RADIUS using a fixed
password. This feature also works with RADIUS accounting, including the phase1 acct-verify option.

Syntax

config vpn ipsec phase1-interface
edit <name>

set mode-cfg enable
set type dynamic
set ike-version 2
set group-authentication {enable | disable}
set group-authentication-secret <password>

next
end

IPsec mode-cfg can assign IPs from firewall address and sharing IP pools (393331)

This feature adds the ability for users to configure assign-IPs from firewall addresses/groups.

Previously, different policies accessing the same network needed to ensure that non-overlapping IP-ranges were
assigned to policies to avoid the same IP address being assigned to multiple clients. With this feature, the
address name is used to identify an IP pool and different policies can refer to the same IP pool to check for
available IPs, thus simplifying the task of avoiding IP conflicts.

Syntax

config vpn ipsec phase1-interface
edit <name>

set mode-cfg enable
set type dynamic
set assign-ip-from {range | dhcp | name}
set ipv4-name <name>
set ipv6-name <name>

next
end

Improve interface-based dynamic IPsec up/down time (379937)

This feature makes it possible to use a single interface for all instances that spawn via a given phase1. Instead of
creating an interface per instance, all traffic will run over the single interface and any routes that need creating will
be created on that single interface.

A new CLI option net-device is added in the phase1-interface command sets. The default is disable
so that the new feature kicks in for all the new configurations. An upgrade feature will add a set net-device
enable for all the existing configurations so that they will keep the old behavior.

Under the new single-interface scheme, instead of relying on routing to guide traffic to the specific instance, all
traffic will flow to the specific device and IPsec will need to take care of locating the correct instance for outbound
traffic. For this purpose, another new CLI option tunnel-search is created. The option is only available when
the above net-device option is set to disable.

There are two options for tunnel-search, corresponding to the two ways to select the tunnel for outbound
traffic. One is selectors, meaning selecting a peer using the IPsec selectors (proxy-ids). The other is

FortiOS Handbook for FortiOS 5.6.7
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nexthop where all the peers use the same default selectors (0/0) while using some routing protocols such as
BGP, OSPF, RIPng, etc. to resolve the routing. The default for tunnel-search is selectors.

Syntax

config vpn ipsec phase1-interface
edit <name>

set net-device {enable | disable}
set tunnel-search {selectors | nexthop}

next
end

Hide psksecret option when peertype is dialup (415480)

In aggressive mode and IKEv2, when peertype is dialup, pre-shared key is per-user based. There is no need to
configure the psksecret in the phase1 setup. Previously, if left unconfigured, CLI would output psksecret error and
fail to create the phase1 profile.

To prevent psksecret length check running on the configuration end, the psksecret option will be hidden. Prior to
Mantis 397712, the length check passed because it was incorrectly checking the legnth of encrypted password
which is always 204 length long.

Peertype dialup option removed for main mode.

New enforce-ipsec option added to L2TP config (423988)

A new enforce-ipsec option is added in L2TP configuration to force the FortiGate L2TP server to accept only
IPsec encrypted connections.

Syntax

config vpn l2tp
set eip 50.0.0.100
set sip 50.0.0.1
set status enable
set enforce-ipsec-interface {disable | enable} (default = disable)
set usrgrp <group_name>

end

IPsec VPN Wizard improvements (368069)

Previously, when using wan-load-balance (WLB) feature, and when configuring an IPsec tunnel with the wizard,
the setting 'incoming interface' list does not contain the wan-load-balance nor the wan2 interface. Disabling the
WLB permits the configuration.

The solution in 5.6.1 is as follows:

l (368069) The IPsec VPN wizard now allows users to select members of virtual-wan-link (VWL) as IPsec phase1-
interface. Before saving, if the phase1 interface is a VWL member, then the Wizard automatically sets the virtual-
wan-link as the destination interface in the L2TP policy.

l (246552) List VPN tunnels for VWL members if VWL is set as the destination interface in policy-based IPsec VPN.
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IPsec manual key support removed from GUI (436041)

The majority of customers are not using policy-based IPsec today, and beyond that, very few are using manual
key VPN. As a result, the IPsec manual key feature is removed from the GUI; the feature store option is removed
as well.

Added GUI support for local-gw when configuring custom IPsec tunnels (423786)

Previously, the local-gw option was not available on the GUI when configuring a custom IPsec tunnel. This
feature adds the local-gw setting to the IPsec VPN Edit dialog. The user is able to choose the primary or
secondary IP address from the currently selected interface, or specify an ip address manually. Both local-gw
and local-gw6 are supported.

Moved the dn-format CLI option from phase1 config to vdom settings (435542)

Previous fix for dn-format didn't take into account that, at the time isakmp_set_peer_identifier is used, we
don't have a connection and haven't matched our gateway yet, so we can't use that to determine the dn-format
configuration setting.

The solution was to move the dn-format CLI option from phase1 config to vdom settings. It is renamed to
ike-dn-format.

FGT IKE incorrect NAT detection causes ADVPN hub behind VIP to not generate shortcuts
(416786)

When ADVPN NAT support was added, only spokes behind NAT was considered. No thought was given to a hub
behind a VIP or the problems that occurred due to the way that FortiOS clients behind NAT enable NAT-T even
when it is not required.

The solution in 5.6.1 is as follows:

l Moved shortcut determination out of the kernel and up to IKE. The shortcut message now contains the ID of both
tunnels so that IKE can check the NAT condition of both.

l Added IKE debug to cover sending the initial shortcut query. The lack of this previously meant it could be awkard to
determine if the offer had been converted into a query correctly.

l Added "nat:" output in diag vpn ike gateway list output to indicate whether this device or the peer is
behind NAT.

l Tweaked the diag vpn tunnel list output so that the auto-discovery information now includes symbolic
as well as numeric values, which makes it easier to see what type of auto-discovery was enabled.

FortiOS 5.6.0
These features first appeared in FortiOS 5.6.0.

Improvement to stats crypto command output (403995)

The CLI command get vpn ipsec stats crypto now has a better format for the information it shows in
differentiating between NP6 lite and SOC3 (CP). To further avoid confusion, all engine's encryption
(encrypted/decrypted) and integrity (generated/validated) information is shown under the same heading, not
separate headings.

FortiOS Handbook for FortiOS 5.6.7
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Improved certificate key size control commands (397883)

Proxy will choose the same SSL key size as the HTTPS server. If the key size from the server is 512, the proxy will
choose 1024. If the key size is bigger than 1024, the proxy will choose 2048.

As a result, the firewall ssl-ssh-profile commands certname-rsa, certname-dsa, and
certname-ecdsa have been replaced with more specific key size control commands under vpn
certificate setting.

CLI syntax

config vpn certificate setting
set certname-rsa1024 <name>
set certname-rsa2048 <name>
set certname-dsa1024 <name>
set certname-dsa2048 <name>
set certname-ecdsa256 <name>
set certname-ecdsa384 <name>

end

Support bit-based keys in IKE (397712)

As per FIPS-CC required standards, as well as RFC 4306, IKE supports pre-shared secrets to be entered as
both ASCII string values and as hexadecimal encoded values. This feature parses hex encoded input (indicated
by the leading characters 0x) and converts the input into binary data for storage.

With this change, the psksecret and psksecret-remote entries under the IPsec VPN CLI command
config vpn ipsec-phase1-interface have been amended to differentiate user input as either ASCII
string or hex encoded values.

IKEv2 asymmetric authentication (393073)

Support added for IKEv2 asymmetric authentication, allowing both sides of an authentication exchange to use
different authentication methods, for example the initiator may be using a shared key, while the responder may
have a public signature key and certificate.

A new command, authmethod-remote, has been added to config vpn ipsec phase1-interface.

For more detailed information on authentication of the IKE SA, see RFC 5996 - Internet Key Exchange Protocol
Version 2 (IKEv2).

Allow mode-cfg with childless IKEv2 (391567)

An issue that prevented childless-ike from being enabled at the same time as mode-cfg has been
resolved. Both options can now be enabled at once under config vpn ipsec phase1-interface.

IKEv2 Digital Signature Authentication support (389001)

FortiOS supports the use of Digital Signature authentication, which changes the format of the Authentication
Data payload in order to support different signature methods.

Instead of just containing a raw signature value calculated as defined in the original IKE RFCs, the Auth Data now
includes an ASN.1 formatted object that provides details on how the signature was calculated, such as the
signature type, hash algorithm, and signature padding method.
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For more detailed information on IKEv2 Digital Signature authentication, see RFC 7427 - Signature
Authentication in the Internet Key Exchange Version 2 (IKEv2).

Passive static IPsec VPN (387913)

New commands have been added to config vpn ipsec phase1-interface to prevent initiating
VPN connection. Static IPsec VPNs can be configured in tunnel mode, without initiating tunnel negotiation or
rekey.

To allow a finer configuration of the tunnel, the rekey option is removed from config system global and
added to config vpn ipsec phase1-interface.

CLI syntax

config vpn ipsec phase1-interface
edit <example>

set rekey {enable | disable}
set passive-mode {enable | disable}
set passive-tunnel-interface {enable | disable}

end

Phase 2 wizard simplified (387725)

Previously, for a site-to-site VPN, phase 2 selectors had their static routes created in the IPsec VPN wizard by
adding IP addresses in string format. Now, since addresses and address groups are already created for these
addresses, the address group can be used in the route directly. This means that the route can be modified simply
by modifying the address/groups that were created when the VPN was initially created.

With this change, the VPN wizard will create less objects internally, and reduce complexity.

In addition, a blackhole route route will be created by default with a higher distance-weight set than the default
route. This is to prevent traffic from flowing out of another route if the VPN interface goes down. In these
instances, the traffic will instead be silently discarded.

Unique IKE ID enforcement (383296)

All IPsec VPN peers now connect with unique IKE identifiers. To implement this, a new phase1 CLI command
has been added (enforce-unique-id) which, when enabled, requires all IPsec VPN clients to use a unique
identifier when connecting.

CLI syntax

config vpn ipsec phase1
edit <name>

set enforce-unique-id {keep-new | keep-old | disable} Default is disable.
next

end

Use keep-new to replace the old connection if an ID collision is detected on the gateway.
Use keep-old to reject the new connection if an ID collision is detected.

FortiView VPN tunnel map feature (382767)

A geospatial map has been added to FortiView to help visualize IPsec and SSL VPN connections to a FortiGate
using Google Maps. Adds geographical-IP API service for resolving spatial locations from IP addresses.

This feature can be found under FortiView > VPN.
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Childless IKEv2 initiation (381650)

As documented in RFC 6023, when both sides support the feature, no child IPsec SA is brought up during the
initial AUTH of the IKEv2 negotiation. Support for this mode is not actually negotiated, but the responder
indicates support for it by including a CHILDLESS_IKEV2_SUPPORTED Notify in the initial SA_INIT reply. The
initiator is then free to send its AUTH without any SA or TS payloads if it also supports this extension.

CLI syntax

config vpn ipsec phase1-interface
edit ike

set ike-version 2
set childless-ike enable

next
end

Due to the way configuration payloads (IKEV2_PAYLOAD_CONFIG) are handled in
the current code base, mode-cfg and childless-ike aren't allowed to be enabled at the
same time. Processing config payloads for mode-cfg requires a child ph2handle to be
created, but with childless-ike we completely avoid creating the child ph2 in the first
place which makes the two features incompatible. It may be possible to support both
in the future, but a deeper rework of the config payload handling is required.

Allow peertype dialup for IKEv2 pre-shared key dynamic phase1 (378714)

Restored peertype dialup that was removed in a previous build (when IKEv2 PSK gateway re-validation was
not yet supported).

If peertype is dialup, IKEv2 AUTH verify uses user password in the user group "usrgrp" of phase1. The
"psksecret" in phase1 is ignored.

CLI syntax

config vpn ipsec phase1-interface
edit "name"

set type dynamic
set interface "wan1"
set ike-version 2
set peertype dialup
set usrgrp "local-group"

next
end

IPsec default phase1/phase1-interface peertype changed from 'any' to 'peer' (376340)

Previously, when authmethod was changed to signature, peertype automatically changed to peer and
required a peer to be set. This change was done to try to provide a more secure initial configuration, while
allowing the admin to set peertype back to any if that's what they really wanted. The default value was kept at
any in the CLI. However, this caused problems with copy/pasting configurations and with FMG because if
peertype any wasn't explicitly provided, the CLI was switched to peertype peer.
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This patch changes the default peertype to peer now; peertype any is considered non-default and will be printed
out on any config listing. Upgrade code has been written to ensure that any older build that was implicitly using
set peertype any has this setting preserved.

IPsec GUI bug fixes (374326)

Accept type "Any peer ID" is available when creating IPsec tunnel with authmethod, pre-shared key, ikev1 main
mode/aggressive mode, and ikev2.

Support for IKEv2 Message Fragmentation (371241)

Added support for IKEv2 Message Fragmentation, as described in RFC 7383.

Previously, when sending and IKE packets with IKEv1, the whole packet is sent once, and it is only fragmented if
there is a retransmission. With IKEv2, because RFC 7383 requires each fragment to be individually encrypted
and authenticated, we would have to keep a copy of the unencrypted payloads around for each outgoing packet,
in case the original single packet was never answered and we wanted to retry with fragments. So with this
implementation, if the IKE payloads are greater than a configured threshold, the IKE packets are preemptively
fragmented and encrypted.

CLI syntax

config vpn ipsec phase1-interface
edit ike

set ike-version 2
set fragmentation [enable|disable]
set fragmentation-mtu [500-16000]

next
end

IPsec monitoring pages now based on phase 1 proposals not phase 2 (304246)

The IPsec monitor, found underMonitor > IPsec Monitor, was in some instances showing random uptimes
even if the tunnel was in fact down.

Tunnels are considered as "up" if at least one phase 2 selector is active. To avoid confusion, when a tunnel is
down, IPsec Monitor will keep the Phase 2 Selectors column, but hide it by default and be replaced with
Phase 1 status column.
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Virtual Private Network (VPN) technology enables remote users to connect to private computer networks to gain
access to their resources in a secure way. For example, an employee traveling or working from home can use a
VPN to securely access the office network through the Internet.

Instead of remotely logging on to a private network using an unencrypted and unsecure Internet connection, the
use of a VPN ensures that unauthorized parties cannot access the office network and cannot intercept any of the
information that is exchanged between the employee and the office. It is also common to use a VPN to connect
the private networks of two or more offices.

Fortinet offers VPN capabilities in the FortiGate Unified Threat Management (UTM) appliance and in the
FortiClient Endpoint Security suite of applications. A FortiGate unit can be installed on a private network, and
FortiClient software can be installed on the user’s computer. It is also possible to use a FortiGate unit to connect
to the private network instead of using FortiClient software.

This chapter discusses VPN terms and concepts including:

VPN tunnels
The data path between a user’s computer and a private network through a VPN is referred to as a tunnel. Like a
physical tunnel, the data path is accessible only at both ends. In the telecommuting scenario, the tunnel runs
between the FortiClient application on the user’s PC, or a FortiGate unit or other network device and the
FortiGate unit on the office private network.

Encapsulation makes this possible. IPsec packets pass from one end of the tunnel to the other and contain data
packets that are exchanged between the local user and the remote private network. Encryption of the data
packets ensures that any third-party who intercepts the IPsec packets can not access the data.

Encoded data going through a VPN tunnel

You can create a VPN tunnel between:

l A PC equipped with the FortiClient application and a FortiGate unit
l Two FortiGate units
l Third-party VPN software and a FortiGate unit

For more information on third-party VPN software, refer to the Fortinet Knowledge Base for more information.

2017 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

http://kb.fortinet.com/


IPsec VPN concepts

Tunnel templates

Several tunnel templates are available in the IPsec VPNWizard that cover a variety of different types of IPsec
VPN. A list of these templates appear on the first page of the Wizard, located at VPN > IPsec Wizard. The
tunnel template list follows.

IPsec VPN Wizard options

VPN Type Remote Device Type NAT Options Description

Site to Site FortiGate l No NAT between sites
l This site is behind
NAT

l The remote site is
behind NAT

Static tunnel between
this FortiGate and a
remote FortiGate.

Cisco

l No NAT between sites
l This site is behind
NAT

l The remote site is
behind NAT

Static tunnel between
this FortiGate and a
remote Cisco firewall.

Remote
Access

Client-
based

FortiClient VPN for OS X,
Windows, and Android

N/A On-demand tunnel for
users using the
FortiClient software.

Cisco AnyConnect N/A On-demand tunnel for
users using the Cisco
IPsec client.

Native iOS Native N/A On-demand tunnel for
iPhone/iPad users
using the native iOS
IPsec client.

Android Native N/A On-demand tunnel for
Android users using
the native L2TP/IPsec
client.

Windows Native N/A On-demand tunnel for
Android users using
the native L2TP/IPsec
client.

Custom N/A N/A No Template.

Cisco's VPN Client has reached its End-of-Life/End-of-Support as of July 30, 2016, and
has been replaced by Cisco AnyConnect Secure Mobility Client.
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In FortiOS 5.6.4+, the first step of the VPN Creation Wizard (VPN > IPsec Wizard)
delineates the Remote Device Type (forRemote Access templates) between
Client-based and Native in order to distinguish FortiClient and Cisco device options
from native OS device options.

VPN tunnel list

Once you create an IPsec VPN tunnel, it appears in the VPN tunnel list at VPN > IPsec Tunnels. By default, the
tunnel list indicates the name of the tunnel, its interface binding, the tunnel template used, and the tunnel status.
If you right-click on the table header row, you can include columns for comments, IKE version, mode (aggressive
vs main), phase 2 proposals, and reference number. The tunnel list page also includes the option to create a new
tunnel, as well as the options to edit or delete a highlighted tunnel.

FortiView VPN tunnel map

A geospatial map can be found under FortiView > VPN Map to help visualize IPsec (and SSL) VPN connections
to a FortiGate using Google Maps. This feature adds a geographical-IP API service for resolving spatial locations
from IP addresses.

VPN gateways
A gateway is a router that connects the local network to other networks. The default gateway setting in your
computer’s TCP/IP properties specifies the gateway for your local network.

A VPN gateway functions as one end of a VPN tunnel. It receives incoming IPsec packets, decrypts the
encapsulated data packets and passes the data packets to the local network. Also, it encrypts data packets
destined for the other end of the VPN tunnel, encapsulates them, and sends the IPsec packets to the other VPN
gateway. The VPN gateway is a FortiGate unit because the private network behind it is protected, ensuring the
security of the unencrypted VPN data. The gateway can also be FortiClient software running on a PC since the
unencrypted data is secure on the PC.

The IP address of a VPN gateway is usually the IP address of the network interface that connects to the Internet.
Optionally, you can define a secondary IP address for the interface and use that address as the local VPN
gateway address. The benefit of doing this is that your existing setup is not affected by the VPN settings.

The following diagram shows a VPN connection between two private networks with FortiGate units acting as the
VPN gateways. This configuration is commonly referred to as Gateway-to-Gateway IPsec VPN.
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VPN tunnel between two private networks

Although the IPsec traffic may actually pass through many Internet routers, you can visualize the VPN tunnel as a
simple secure connection between the two FortiGate units.

Users on the two private networks do not need to be aware of the VPN tunnel. The applications on their
computers generate packets with the appropriate source and destination addresses, as they normally do. The
FortiGate units manage all the details of encrypting, encapsulating, and sending the packets to the remote VPN
gateway.

The data is encapsulated in IPsec packets only in the VPN tunnel between the two VPN gateways. Between the
user’s computer and the gateway, the data is on the secure private network and it is in regular IP packets.

For example User1 on the Site A network, at IP address 10.10.1.7, sends packets with destination IP address
192.168.10.8, the address of User2 on the Site B network. The Site A FortiGate unit is configured to send packets
with destinations on the 192.168.10.0 network through the VPN, encrypted and encapsulated. Similarly, the Site
B FortiGate unit is configured to send packets with destinations on the 10.10.1.0 network through the VPN tunnel
to the Site A VPN gateway.

In the site-to-site, or gateway-to-gateway VPN shown below, the FortiGate units have static (fixed) IP addresses
and either unit can initiate communication.

You can also create a VPN tunnel between an individual PC running FortiClient and a FortiGate unit, as shown
below. This is commonly referred to as Client-to-Gateway IPsec VPN.
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VPN tunnel between a FortiClient PC and a FortiGate unit

On the PC, the FortiClient application acts as the local VPN gateway. Packets destined for the office network are
encrypted, encapsulated into IPsec packets, and sent through the VPN tunnel to the FortiGate unit. Packets for
other destinations are routed to the Internet as usual. IPsec packets arriving through the tunnel are decrypted to
recover the original IP packets.

Clients, servers, and peers
A FortiGate unit in a VPN can have one of the following roles:

l Server— responds to a request to establish a VPN tunnel.
l Client— contacts a remote VPN gateway and requests a VPN tunnel.
l Peer— brings up a VPN tunnel or responds to a request to do so.

The site-to-site VPN shown above is a peer-to-peer relationship. Either FortiGate unit VPN gateway can establish
the tunnel and initiate communications. The FortiClient-to-FortiGate VPN shown below is a client-server
relationship. The FortiGate unit establishes a tunnel when the FortiClient PC requests one.

A FortiGate unit cannot be a VPN server if it has a dynamically-assigned IP address. VPN clients need to be
configured with a static IP address for the server. A FortiGate unit acts as a server only when the remote VPN
gateway has a dynamic IP address or is a client-only device or application, such as FortiClient.

As a VPN server, a FortiGate unit can also offer automatic configuration for FortiClient PCs. The user needs to
know only the IP address of the FortiGate VPN server and a valid user name/password. FortiClient downloads the
VPN configuration settings from the FortiGate VPN server. For information about configuring a FortiGate unit as
a VPN server, see the FortiClient Administration Guide.
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Encryption
Encryption mathematically transforms data to appear as meaningless random numbers. The original data is
called plaintext and the encrypted data is called ciphertext. The opposite process, called decryption, performs the
inverse operation to recover the original plaintext from the ciphertext.

The process by which the plaintext is transformed to ciphertext and back again is called an algorithm. All
algorithms use a small piece of information, a key, in the arithmetic process of converted plaintext to ciphertext,
or vice-versa. IPsec uses symmetrical algorithms, in which the same key is used to both encrypt and decrypt the
data. The security of an encryption algorithm is determined by the length of the key that it uses. FortiGate IPsec
VPNs offer the following encryption algorithms, in descending order of security:

Encryption Description

AES-GCM Galois/Counter Mode (GCM), a block cipher mode of operation providing
both confidentiality and data origin authentication.

AES256 A 128-bit block algorithm that uses a 256-bit key.

AES192 A 128-bit block algorithm that uses a 192-bit key.

AES128 A 128-bit block algorithm that uses a 128-bit key.

3DES Triple-DES, in which plain text is DES-encrypted three times by three keys.

DES Digital Encryption Standard, a 64-bit block algorithm that uses a 56-bit key

The default encryption algorithms provided on FortiGate units make recovery of encrypted data almost
impossible without the proper encryption keys.

There is a human factor in the security of encryption. The key must be kept secret, known only to the sender and
receiver of the messages. Also, the key must not be something that unauthorized parties might easily guess,
such as the sender’s name, birthday or simple sequence such as 123456.

Diffie-Hellman groups

FortiOS IPsec VPN supports the following Diffie-Hellman (DH) asymmetric key algorithms for public key
cryptography.

DH Group Description

1 More Modular Exponential (MODP) DH Group with a 768-bit modulus.

2 MODPwith a 1024-bit modulus.

5 MODPwith a 1536-bit modulus.

14 MODPwith a 2048-bit modulus.

15 MODPwith a 3027-bit modulus.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2022



IPsec VPN concepts

DH Group Description

16 MODPwith a 4096-bit modulus.

17 MODPwith a 6144-bit modulus.

18 MODPwith a 8192-bit modulus.

19 256-bit random elliptic curve group.

20 384-bit random elliptic curve group.

21 521-bit random elliptic curve group.

27 Brainpool 224-bit elliptic curve group.

28 Brainpool 256-bit elliptic curve group.

29 Brainpool 384-bit elliptic curve group.

30 Brainpool 512-bit elliptic curve group.

* When using aggressive mode, DH groups cannot be negotiated.

By default, DH group 14 is selected, to provide sufficient protection for stronger cipher suites that include AES
and SHA2. If you select multiple DH groups, the order they appear in the configuration is the order in which they
are negotiates.

If both VPN peers (or a VPN server and its client) have static IP addresses and use aggressive mode, select a
single DH group. The setting on the FortiGate unit must be identical to the setting on the remote peer or dialup
client.

When the remote VPN peer or client has a dynamic IP address and uses aggressive mode, select up to three DH
groups on the FortiGate unit and one DH group on the remote peer or dialup client. The setting on the remote
peer or dialup client must be identical to one of the selections on the FortiGate unit.

If the VPN peer or client employs main mode, you can select multiple DH groups. At least one of the settings on
the remote peer or dialup client must be identical to the selections on the FortiGate unit.

IPsec overheads

The FortiGate sets an IPsec tunnel Maximum Transmission Unit (MTU) of 1436 for 3DES/SHA1 and an MTU of
1412 for AES128/SHA1, as seen with diag vpn tunnel list. This indicates that the FortiGate allocates 64
bytes of overhead for 3DES/SHA1 and 88 bytes for AES128/SHA1, which is the difference if you subtract this
MTU from a typical ethernet MTU of 1500 bytes.

During the encryption process, AES/DES operates using a specific size of data which is block size. If data is
smaller than that, it will be padded for the operation. MD5/SHA-1 HMAC also operates using a specific block size.

The following table describes the potential maximum overhead for each IPsec encryption:
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IPsec Transform Set IPsec Overhead (Max. bytes)

ESP-AES (256, 192, or 128),ESP-SHA-HMAC, or MD5 88

ESP-AES (256, 192, or 128) 61

ESP-3DES, ESP-DES 45

ESP-(DES or 3DES), ESP-SHA-HMAC, or MD5 64

ESP-Null, ESP-SHA-HMAC, or MD5 45

AH-SHA-HMAC or MD5 44

Authentication
To protect data via encryption, a VPNmust ensure that only authorized users can access the private network. You
must use either a preshared key on both VPN gateways or RSA X.509 security certificates. The examples in this
guide use only preshared key authentication. Refer to the Fortinet Knowledge Base for articles on RSA X.509
security certificates.

Preshared keys

A preshared key contains at least six random alphanumeric characters. Users of the VPNmust obtain the
preshared key from the person who manages the VPN server and add the preshared key to their VPN client
configuration.

Although it looks like a password, the preshared key, also known as a shared secret, is never sent by either
gateway. The preshared key is used in the calculations at each end that generate the encryption keys. As soon as
the VPN peers attempt to exchange encrypted data, preshared keys that do not match will cause the process to
fail.

Additional authentication

To increase security, you can require additional means of authentication from users, such as:

l An identifier, called a peer ID or a local ID.
l Extended authentication (XAUTH) which imposes an additional user name/password requirement.

A Local ID is an alphanumeric value assigned in the Phase 1 configuration. The Local ID of a peer is called a Peer
ID.

In FortiOS 5.2, new authentication methods have been implemented for IKE: ECDSA-256, ECDSA-384, and
ECDSA-521. However, AES-XCBC is not supported.

Phase 1 and Phase 2 settings
A VPN tunnel is established in two phases: Phase 1 and Phase 2. Several parameters determine how this is done.
Except for IP addresses, the settings simply need to match at both VPN gateways. There are defaults that are
appropriate for most cases.
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FortiClient distinguishes between Phase 1 and Phase 2 only in the VPN Advanced settings and uses different
terms. Phase 1 is called the IKE Policy. Phase 2 is called the IPsec Policy.

Phase 1

In Phase 1, the two VPN gateways exchange information about the encryption algorithms that they support and
then establish a temporary secure connection to exchange authentication information.

When you configure your FortiGate unit or FortiClient application, you must specify the following settings for
Phase 1:

Remote gateway The remote VPN gateway’s address.

FortiGate units also have the option of operating only as a server by
selecting the “Dialup User” option.

Preshared key This must be the same at both ends. It is used to encrypt Phase 1
authentication information.

Local interface The network interface that connects to the other VPN gateway. This
applies on a FortiGate unit only.

All other Phase 1 settings have default values. These settings mainly configure the types of encryption to be
used. The default settings on FortiGate units and in the FortiClient application are compatible. The examples in
this guide use these defaults.

For more detailed information about Phase 1 settings, see Phase 1 parameters on page 2048.

Phase 2

Similar to the Phase 1 process, the two VPN gateways exchange information about the encryption algorithms that
they support for Phase 2. You may choose different encryption for Phase 1 and Phase 2. If both gateways have at
least one encryption algorithm in common, a VPN tunnel can be established. Keep in mind that more algorithms
each phase does not share with the other gateway, the longer negotiations will take. In extreme cases this may
cause timeouts during negotiations.

To configure default Phase 2 settings on a FortiGate unit, you need only select the name of the corresponding
Phase 1 configuration. In FortiClient, no action is required to enable default Phase 2 settings.

For more detailed information about Phase 2 settings, see Phase 2 parameters on page 2067.

Security Association
The establishment of a Security Association (SA) is the successful outcome of Phase 1 negotiations. Each peer
maintains a database of information about VPN connections. The information in each SA can include
cryptographic algorithms and keys, keylife, and the current packet sequence number. This information is kept
synchronized as the VPN operates. Each SA has a Security Parameter Index (SPI) that is provided to the remote
peer at the time the SA is established. Subsequent IPsec packets from the peer always reference the relevant
SPI. It is possible for peers to have multiple VPNs active simultaneously, and correspondingly multiple SPIs.

The IPsec SA connect message generated is used to install dynamic selectors. These selectors can be installed
via the auto-negotiate mechanism. When phase 2 has auto-negotiate enabled, and phase 1 has mesh selector-
type set to subnet, a new dynamic selector will be installed for each combination of source and destination
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subnets. Each dynamic selector will inherit the auto-negotiate option from the template selector and begin SA
negotiation. Phase 2 selector sources from dial-up clients will all establish SAs without traffic being initiated from
the client subnets to the hub.

Remote IP address change detection

SAs are stored in a hash table when keyed off the IPsec SA SPI value. This enables the FortiGate, for each
inbound ESP packet received, to immediately look up the SA and compare the stored IP address against the one
in the incoming packet. If the incoming and stored IP addresses differ, an IP address change can be made in the
kernel SA, and an update event can be triggered for IKE.

IKE and IPsec packet processing
Internet Key Exchange (IKE) is the protocol used to set up SAs in IPsec negotiation. As described in Phase 1
parameters on page 2048, you can optionally choose IKEv2 over IKEv1 if you configure a route-based IPsec VPN.
IKEv2 simplifies the negotiation process, in that it provides no choice of Aggressive or Main mode in Phase 1.
IKEv2 also uses less bandwidth.

The following sections identify how IKE versions 1 and 2 operate and differentiate.

IKEv1

Phase 1

A peer, identified in the IPsec policy configuration, begins the IKE negotiation process. This IKE Security
Association (SA) agreement is known as Phase 1. The Phase 1 parameters identify the remote peer or clients and
supports authentication through pre-shared key (PSK) or digital certificate. You can increase access security
further using peer identifiers, certificate distinguished names, group names, or the FortiGate extended
authentication (XAuth) option for authentication purposes. Basically, Phase 1 authenticates a remote peer and
sets up a secure communication channel for establishing Phase 2, which negotiates the IPsec SA.

IKE Phase 1 can occur in either Main mode or Aggressive mode. For more information, see Phase 1 parameters
on page 2048.

IKE Phase 1 is successful only when the following are true:

l Each peer negotiates a matching IKE SA policy.
l Each peer is authenticated and their identities protected.
l The Diffie-Hellman exchange is authenticated (the pre-shared secret keys match).

For more information on Phase 1, see Phase 1 parameters on page 2048.

Phase 2

Phase 2 parameters define the algorithms that the FortiGate unit can use to encrypt and transfer data for the
remainder of the session in an IPsec SA. The basic Phase 2 settings associate IPsec Phase 2 parameters with a
Phase 1 configuration.

In Phase 2, the VPN peer or client and the FortiGate unit exchange keys again to establish a more secure
communication channel. The Phase 2 Proposal parameters select the encryption and authentication algorithms
needed to generate keys for protecting the implementation details of the SA. The keys are generated
automatically using a Diffie-Hellman algorithm.
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In Phase 2, Quick mode selectors determine which IP addresses can perform IKE negotiations to establish a
tunnel. By only allowing authorized IP addresses access to the VPN tunnel, the network is more secure. For more
information, see Phase 2 parameters on page 2067.

IKE Phase 2 is successful only when the following are true:

l The IPsec SA is established and protected by the IKE SA.
l The IPsec SA is configured to renegotiate after set durations (see Phase 2 parameters on page 2067 and Phase 2

parameters on page 2067).
l Optional:Replay Detection is enabled. Replay attacks occur when an unauthorized party intercepts a series of

IPsec packets and replays them back into the tunnel. See Phase 2 parameters on page 2067.
l Optional: Perfect Forward Secrecy (PFS) is enabled. PFS improves security by forcing a new Diffie-Hellman

exchange whenever keylife expires. See Phase 2 parameters on page 2067.

For more information on Phase 2, see Phase 2 parameters on page 2067.

With Phase 2 established, the IPsec tunnel is fully negotiated and traffic between the peers is allowed until the
SA terminates (for any number of reasons; time-out, interruption, disconnection, etc).

The entire IKEv1 process is demonstrated in the following diagram:

IKEv2

Phase 1

Unlike Phase 1 of IKEv1, IKEv2 does not provide options for Aggressive or Main mode. Furthermore, Phase 1 of
IKEv2 begins immediately with an IKE SA initiation, consisting of only two packets (containing all the information
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typically contained in four packets for IKEv1), securing the channel such that all following transactions are
encrypted (see Phase 1 parameters on page 2048).

The encrypted transactions contain the IKE authentication, since remote peers have yet to be authenticated. This
stage of IKE authentication in IKEv2 can loosely be called Phase 1.5.

Phase 1.5

As part of this phase, IKE authentication must occur. IKE authentication consists of the following:

l The authentication payloads and Internet Security Association and Key Management Protocol (ISAKMP) identifier.
l The authentication method (RSA, PSK, ECDSA, or EAP).
l The IPsec SA parameters.

Due to the number of authentication methods potentially used, and SAs established, the overall IKEv2
negotiation can range from 4 packets (no EAP exchange at all) to many more.

At this point, both peers have a security association complete and ready to encrypt traffic.

Phase 2

In IKEv1, Phase 2 uses Quick mode to negotiate an IPsec SA between peers. In IKEv2, since the IPsec SA is
already established, Phase 2 is essentially only used to negotiate “child” SAs, or to re-key an IPsec SA. That said,
there are only two packets for each exchange of this type, similar to the exchange at the outset of Phase 1.5.

The entire IKEv2 process is demonstrated in the following diagram:

Support for IKEv2 session resumption

If a gateway loses connectivity to the network, clients can attempt to re-establish the lost session by presenting
the ticket to the gateway (as described in RFC 5723). As a result, sessions can be resumed much faster, as DH
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exchange that is necessary to establish a brand new connection is skipped. This feature implements "ticket-by-
value", whereby all information necessary to restore the state of a particular IKE SA is stored in the ticket and sent
to the client.

IKEv2 asymmetric authentication

Asymmetric authentication allows both sides of an authentication exchange to use different authentication
methods, for example the initiator may be using a shared key, while the responder may have a public signature
key and certificate.

The command authmethod-remote is avilable under config vpn ipsec phase1-interface.

For more detailed information on authentication of the IKE SA, see RFC 5996 - Internet Key Exchange Protocol
Version 2 (IKEv2).

IKEv2 Digital Signature Authentication support

FortiOS supports the use of Digital Signature authentication, which changes the format of the Authentication
Data payload in order to support different signature methods.

Instead of just containing a raw signature value calculated as defined in the original IKE RFCs, the Auth Data now
includes an ASN.1 formatted object that provides details on how the signature was calculated, such as the
signature type, hash algorithm, and signature padding method.

For more detailed information on IKEv2 Digital Signature authentication, see RFC 7427 - Signature
Authentication in the Internet Key Exchange Version 2 (IKEv2).

Unique IKE identifiers

When enabled, the following phase1 CLI command (enforce-unique-id) requires all IPsec VPN clients to
use a unique identifer when connecting.

CLI syntax

config vpn ipsec phase1
edit <name>

set enforce-unique-id {keep-new | keep-old | disable} Default is disable.
next

end

Use keep-new to replace the old connnection if an ID collision is detected on the gateway.
Use keep-old to reject the new connection if an ID collision is detected.

IKEv2 ancillary RADIUS group authentication

This feature provides for the IDi information to be extracted from the IKEv2 AUTH exchange and sent to a
RADIUS server, along with a fixed password (configurable via CLI only), to perform an additional group
authentication step prior to tunnel establishment. The RADIUS server may return framed-IP-address, framed-ip-
netmask, and dns-server attributes, which are then applied to the tunnel.

It should be noted, unlike Xauth or EAP, this feature does not perform individual user authentication, but rather
treats all users on the gateway as a single group, and authenticates that group with RADIUS using a fixed
password. This feature also works with RADIUS accounting, including the phase1 acct-verify option.
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Syntax

config vpn ipsec phase1-interface
edit <name>

set mode-cfg enable
set type dynamic
set ike-version 2
set group-authentication {enable | disable}
set group-authentication-secret <password>

next
end
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This section provides a brief overview of IPsec technology and includes general information about how to
configure IPsec VPNs using this guide.

The following topics are included in this section:

VPN configurations interact with the firewall component of the FortiGate unit. There must be a security policy in
place to permit traffic to pass between the private network and the VPN tunnel.

Security policies for VPNs specify:

l The FortiGate interface that provides the physical connection to the remote VPN gateway, usually an interface
connected to the Internet

l The FortiGate interface that connects to the private network
l IP addresses associated with data that has to be encrypted and decrypted
l Optionally, a schedule that restricts when the VPN can operate
l Optionally, the services (types of data) that can be sent

When the first packet of data that meets all of the conditions of the security policy arrives at the FortiGate unit, a
VPN tunnel may be initiated and the encryption or decryption of data is performed automatically afterward. For
more information, see Defining VPN security policies on page 1.

Where possible, you should create route-based VPNs. Generally, route-based VPNs are more flexible and easier
to configure than policy-based VPNs— by default they are treated as interfaces. However, these two VPN types
have different requirements that limit where they can be used.

Types of VPNs
FortiGate unit VPNs can be policy-based or route-based. There is little difference between the two types. In both
cases, you specify Phase 1 and Phase 2 settings. However there is a difference in implementation. A route-based
VPN creates a virtual IPsec network interface that applies encryption or decryption as needed to any traffic that it
carries. That is why route-based VPNs are also known as interface-based VPNs. A policy-based VPN is
implemented through a special security policy that applies the encryption you specified in the Phase 1 and Phase
2 settings.

Route-based VPNs

For a route-based VPN, you create two security policies between the virtual IPsec interface and the interface that
connects to the private network. In one policy, the virtual interface is the source. In the other policy, the virtual
interface is the destination. This creates bidirectional policies that ensure traffic will flow in both directions over
the VPN.

A route-based VPN is also known as an interface-based VPN.

Each route-based IPsec VPN tunnel requires a virtual IPsec interface. As such, the
amount of possible route-based IPsec VPNs is limited by the system.interface table
size. The system.interface table size for most devices is 8192.

For a complete list of table sizes for all devices, refer to the Maximum Values table.
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Policy-based VPNs

For a policy-based VPN, one security policy enables communication in both directions. You enable inbound and
outbound traffic as needed within that policy, or create multiple policies of this type to handle different types of
traffic differently. For example HTTPS traffic may not require the same level of scanning as FTP traffic.

A policy-based VPN is also known as a tunnel-mode VPN.

Comparing policy-based or route-based VPNs

For both VPN types you create Phase 1 and Phase 2 configurations. Both types are handled in the stateful
inspection security layer, assuming there is no IPS or AV.

The main difference is in the security policy.

You create a policy-based VPN by defining an IPSEC security policy between two network interfaces and
associating it with the VPN tunnel (Phase 1) configuration.

You create a route-based VPN by creating a virtual IPsec interface. You then define a regular ACCEPT security
policy to permit traffic to flow between the virtual IPsec interface and another network interface. And lastly,
configure a static route to allow traffic over the VPN.

Where possible, you should create route-based VPNs. Generally, route-based VPNs are more flexible and easier
to configure than policy-based VPNs— by default they are treated as interfaces. However, these two VPN types
have different requirements that limit where they can be used.

Comparison of policy-based and route-based VPNs

Features Policy-based Route-based

Both NAT and transparent
modes available

Yes NAT mode only

L2TP-over-IPsec supported Yes Yes

GRE-over-IPsec supported No Yes

security policy requirements
Requires a security policy with
IPSEC action that specifies the
VPN tunnel

Requires only a simple security
policy with ACCEPT action

Number of policies per VPN One policy controls connections in
both directions

A separate policy is required for
connections in each direction

Planning your VPN
It is a good idea to plan the VPN configuration ahead of time. This will save time later and help you configure your
VPN correctly.

All VPN configurations are comprised of numerous required and optional parameters. Before you begin, you need
to determine:
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l Where the IP traffic originates and where it needs to be delivered
l Which hosts, servers, or networks to include in the VPN
l Which VPN devices to include in the configuration
l Through which interfaces the VPN devices communicate
l Through which interfaces do private networks access the VPN gateways

Once you have this information, you can select a VPN topology that suits the network environment.

Network topologies

The topology of your network will determine how remote peers and clients connect to the VPN and how VPN
traffic is routed.

VPN network topologies and brief descriptions

Topology Description

Gateway-to-gateway
configurations

Standard one-to-one VPN between two FortiGate units. See Gateway-to-
gateway configurations on page 1.

Hub-and-spoke configurations One central FortiGate unit has multiple VPNs to other remote FortiGate
units. See Hub-and-spoke configurations on page 1.

Dynamic DNS configuration One end of the VPN tunnel has a changing IP address and the other end
must go to a dynamic DNS server for the current IP address before
establishing a tunnel. See Dynamic DNS configuration on page 1.

FortiClient dialup-client
configurations

Typically remote FortiClient dialup-clients use dynamic IP addresses
through NAT devices. The FortiGate unit acts as a dialup server allowing
dialup VPN connections from multiple sources. See FortiClient dialup-client
configurations on page 1.

FortiGate dialup-client
configurations

Similar to FortiClient dialup-client configurations but with more gateway-to-
gateway settings such as unique user authentication for multiple users on a
single VPN tunnel. See FortiGate dialup-client configurations on page 1.

Internet-browsing
configuration

Secure web browsing performed by dialup VPN clients, and/or hosts behind
a remote VPN peer. See Internet-browsing configuration on page 1.

Redundant VPN
configurations

Options for supporting redundant and partially redundant IPsec VPNs,
using route-based approaches. See Redundant VPN configurations on
page 1.

Transparent mode VPNs
In transparent mode, the FortiGate acts as a bridge with all incoming traffic
being broadcast back out on all other interfaces. Routing and NAT must be
performed on external routers. See Transparent mode VPNs on page 1.

L2TP and IPsec (Microsoft
VPN)

Configure VPN for Microsoft Windows dialup clients using the built in L2TP
software. Users do not have to install any See L2TP and IPsec (Microsoft
VPN) on page 1.
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These sections contain high-level configuration guidelines with cross-references to detailed configuration
procedures. If you need more detail to complete a step, select the cross-reference in the step to drill-down to
more detail. Return to the original procedure to complete the procedure. For a general overview of how to
configure a VPN, see Planning your VPN .

General preparation steps
A VPN configuration defines relationships between the VPN devices and the private hosts, servers, or networks
making up the VPN. Configuring a VPN involves gathering and recording the following information. You will need
this information to configure the VPN.

l The private IP addresses of participating hosts, servers, and/or networks. These IP addresses represent
the source addresses of traffic that is permitted to pass through the VPN. A IP source address can be an individual
IP address, an address range, or a subnet address.

l The public IP addresses of the VPN end-point interfaces. The VPN devices establish tunnels with each other
through these interfaces.

l The private IP addresses associated with the VPN-device interfaces to the private networks. Computers
on the private networks behind the VPN gateways will connect to their VPN gateways through these interfaces.

How to use this guide to configure an IPsec VPN
This guide uses a task-based approach to provide all of the procedures needed to create different types of VPN
configurations. Follow the step-by-step configuration procedures in this guide to set up the VPN.

The following configuration procedures are common to all IPsec VPNs:

1. Define the Phase 1 parameters that the FortiGate unit needs to authenticate remote peers or clients and establish
a secure a connection. See Phase 1 parameters on page 2048.

2. Define the Phase 2 parameters that the FortiGate unit needs to create a VPN tunnel with a remote peer or dialup
client. See Phase 2 parameters on page 2067.

3. Specify the source and destination addresses of IP packets that are to be transported through the VPN tunnel. See
Defining policy addresses on page 1.

4. Create an IPsec security policy to define the scope of permitted services between the IP source and destination
addresses. See Defining VPN security policies on page 1.

These steps assume you configure the FortiGate unit to generate unique IPsec
encryption and authentication keys automatically. In situations where a remote VPN
peer or client requires a specific IPsec encryption and authentication key, you must
configure the FortiGate unit to use manual keys instead of performing Steps 1 and 2.
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To configure an IPsec VPN, use the general procedure below. With these steps, your FortiGate unit will
automatically generate unique IPsec encryption and authentication keys. If a remote VPN peer or client requires a
specific IPsec encryption or authentication key, you must configure your FortiGate unit to use manual keys
instead.

1. Define Phase 1 parameters to authenticate remote peers and clients for a secure connection. See IPsec VPN in
the web-based manager on page 2035.

2. Define Phase 2 parameters to create a VPN tunnel with a remote peer or dialup client. See IPsec VPN in the web-
based manager on page 2035.

3. Create a security policy to permit communication between your private network and the VPN. Policy-based VPNs
have an action of IPSEC, where for interface-based VPNs the security policy action is ACCEPT. See Defining VPN
security policies on page 1.

The FortiGate unit implements the Encapsulated Security Payload (ESP) protocol. Internet Key Exchange (IKE) is
performed automatically based on pre-shared keys or X.509 digital certificates. Interface mode, supported in NAT
mode only, creates a virtual interface for the local end of a VPN tunnel.

This chapter contains the following sections:

Phase 1 configuration
To begin defining the Phase 1 configuration, go to VPN > IPsec Tunnels and select Create New. Enter a
unique descriptive name for the VPN tunnel and follow the instructions in the VPN Creation Wizard.

The Phase 1 configuration mainly defines the ends of the IPsec tunnel. The remote end is the remote gateway
with which the FortiGate unit exchanges IPsec packets. The local end is the FortiGate interface that sends and
receives IPsec packets.

If you want to control how the IKE negotiation is processed when there is no traffic, as well as the length of time
the FortiGate unit waits for negotiations to occur, you can use the negotiation-timeout and auto-
negotiate commands in the CLI.

For more information, refer to Phase 2 parameters on page 2067 and Phase 2 parameters on page 2067.

Name Type a name for the Phase 1 definition. The maximum name length is 15
characters for an interface mode VPN, 35 characters for a policy-based
VPN. If Remote Gateway isDialup User, the maximum name length is
further reduced depending on the number of dialup tunnels that can be
established: by 2 for up to 9 tunnels, by 3 for up to 99 tunnels, 4 for up to
999 tunnels, and so on.

For a tunnel mode VPN, the name normally reflects where the remote
connection originates. For a route-based tunnel, the FortiGate unit also
uses the name for the virtual IPsec interface that it creates automatically.
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Remote Gateway

Select the category of the remote connection:

Static IP Address— If the remote peer has a static IP address.
Dialup User— If one or more FortiClient or FortiGate dialup clients with
dynamic IP addresses will connect to the FortiGate unit.
Dynamic DNS— If a remote peer that has a domain name and
subscribes to a dynamic DNS service will connect to the FortiGate unit.

IP Address If you selected Static IP Address, enter the IP address of the remote
peer.

Dynamic DNS If you selected Dynamic DNS, enter the domain name of the remote
peer.

Local Interface This option is available in NAT mode only. Select the name of the interface
through which remote peers or dialup clients connect to the FortiGate unit.

By default, the local VPN gateway IP address is the IP address of the
interface that you selected.

Mode

Main mode— the Phase 1 parameters are exchanged in multiple rounds
with encrypted authentication information.
Aggressive mode— the Phase 1 parameters are exchanged in single
message with authentication information that is not encrypted.

When the remote VPN peer has a dynamic IP address and is authenticated
by a pre-shared key, you must select Aggressive mode if there is more than
one dialup phase1 configuration for the interface IP address.

When the remote VPN peer has a dynamic IP address and is authenticated
by a certificate, you must select Aggressive mode if there is more than one
Phase 1 configuration for the interface IP address and these Phase 1
configurations use different proposals.

Authentication Method Select Preshared Key orRSA Signature.

Pre-shared Key

If you selected Pre-shared Key, enter the pre-shared key that the
FortiGate unit will use to authenticate itself to the remote peer or dialup
client during Phase 1 negotiations. You must define the same key at the
remote peer or client.

The key must contain at least 6 printable characters. For optimum
protection against currently known attacks, the key must consist of a
minimum of 16 randomly chosen alphanumeric characters. The limit is 128
characters.

Certificate Name If you selected RSA Signature, select the name of the server certificate
that the FortiGate unit will use to authenticate itself to the remote peer or
dialup client during Phase 1 negotiations.
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Peer Options Peer options are available to authenticate VPN peers or clients, depending
on the Remote Gateway and Authentication Method settings.

Any peer ID Accept the local ID of any remote VPN peer or client. The FortiGate unit
does not check identifiers (local IDs). You can set Mode to Aggressive or
Main.

You can use this option with RSA Signature authentication. But, for highest
security, configure a PKI user/group for the peer and set Peer Options to
Accept this peer certificate only.

This peer ID

This option is available when Aggressive Mode is enabled. Enter the
identifier that is used to authenticate the remote peer. This identifier must
match the Local ID that the remote peer’s administrator has configured.

If the remote peer is a FortiGate unit, the identifier is specified in the Local
ID field of the Advanced Phase 1 configuration.

If the remote peer is a FortiClient user, the identifier is specified in the
Local ID field, accessed by selecting Config in the Policy section of the
VPN connection’s Advanced Settings.

In circumstances where multiple remote dialup VPN tunnels exist, each
tunnel must have a peer ID set.

Peer ID from dialup group Authenticate multiple FortiGate or FortiClient dialup clients that use unique
identifiers and unique pre-shared keys (or unique pre-shared keys only)
through the same VPN tunnel.

You must create a dialup user group for authentication purposes. Select
the group from the list next to the Peer ID from dialup group option.

You must set Mode to Aggressivewhen the dialup clients use unique
identifiers and unique pre-shared keys. If the dialup clients use unique pre-
shared keys only, you can set Mode toMain if there is only one dialup
Phase 1 configuration for this interface IP address.

Phase 1 advanced configuration settings

You can use the following advanced parameters to select the encryption and authentication algorithms that the
FortiGate unit uses to generate keys for the IKE exchange. You can also use the following advanced parameters
to ensure the smooth operation of Phase 1 negotiations.

These settings are mainly configured in the CLI, although some options are available after the tunnel is created
using the VPN Creation Wizard (using the Convert to Custom Tunnel option).
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If the FortiGate unit will act as a VPN client, and you are using security certificates for
authentication, set the Local ID to the distinguished name (DN) of the local server
certificate that the FortiGate unit will use for authentication purposes.

Note that, since FortiOS 5.4, an exact match is required to optimize IKE's gateway
search utilizing binary trees. However, it is also possible to have partial matching of
'user.peer:cn' to match peers to gateways by performing a secondary match. When
IKE receives IDi of type ASN1.DN, the first search is done with the whole DN string. If
none is found, IKE will extract just the CN attribute value and perform a second
search.

VXLAN over IPsec Packets with VXLAN header are encapsulated within IPsec tunnel mode.

To configure VXLAN over IPsec - CLI:
config vpn ipsec phase1-interface/phase1

edit ipsec
set interface <name>
set encapsulation vxlan/gre
set encapsulation-address ike/ipv4/ipv6
set encap-local-gw4 xxx.xxx.xxx.xxx
set encap-remote-gw xxx.xxx.xxx.xxx

next
end

IPsec tunnel idle timer

You can define an idle timer for IPsec tunnels. When no traffic has passed
through the tunnel for the configured idle-timeout value, the IPsec tunnel
will be flushed.

To configure IPsec tunnel idle timeout - CLI:
config vpn ipsec phase1-interface

edit p1
set idle-timeout [enable | disable]
set idle-timeoutinterval <integer> //IPsec tunnel

idle timeout in minutes (10 - 43200).
end

end

IPv6 Version Select if you want to use IPv6 addresses for the remote gateway and
interface IP addresses.

Local Gateway IP

Specify an IP address for the local end of the VPN tunnel. Select one of the
following:

Main Interface IP — The FortiGate unit obtains the IP address of the
interface from the network interface settings.
Specify— Enter a secondary address of the interface selected in the
Phase 1 Local Interface field.

You cannot configure Interface mode in a transparent mode VDOM.
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Phase 1 Proposal Select the encryption and authentication algorithms used to generate keys
for protecting negotiations and add encryption and authentication
algorithms as required.

You need to select a minimum of one and a maximum of three
combinations. The remote peer or client must be configured to use at least
one of the proposals that you define.

Select one of the following symmetric-key encryption algorithms:

DES— Digital Encryption Standard, a 64-bit block algorithm that uses a
56-bit key.
3DES— Triple-DES; plain text is encrypted three times by three keys.
AES128— A128-bit block algorithm that uses a 128-bit key.
AES192— A128-bit block algorithm that uses a 192-bit key.
AES256— A128-bit block algorithm that uses a 256-bit key.

You can select either of the following message digests to check the
authenticity of messages during an encrypted session:

MD5—Message Digest 5.
SHA1— Secure Hash Algorithm 1 - a 160-bit message digest.

To specify one combination only, set the Encryption and Authentication
options of the second combination to NULL. To specify a third
combination, use the Add button beside the fields for the second
combination.

Diffie-Hellman Group Select one or more Diffie-Hellman groups from DH groups 1, 2, 5, and 14
through 21. At least one of the Diffie-Hellman Group settings on the
remote peer or client must match one the selections on the FortiGate unit.
Failure to match one or more DH groups will result in failed negotiations.

Keylife
Enter the time (in seconds) that must pass before the IKE encryption key
expires. When the key expires, a new key is generated without interrupting
service. The keylife can be from 120 to 172 800 seconds.
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Local ID If the FortiGate unit will act as a VPN client and you are using peer IDs for
authentication purposes, enter the identifier that the FortiGate unit will
supply to the VPN server during the Phase 1 exchange.

If the FortiGate unit will act as a VPN client, and you are using security
certificates for authentication, select the distinguished name (DN) of the
local server certificate that the FortiGate unit will use for authentication
purposes.

If the FortiGate unit is a dialup client and will not be sharing a tunnel with
other dialup clients (that is, the tunnel will be dedicated to this Fortinet
dialup client), set Mode to Aggressive.

Note that this Local ID value must match the peer ID value given for the
remote VPN peer’s Peer Options.

XAuth

This option supports the authentication of dialup clients. It is available for
IKE v1 only.

Disable— Select if you do not use XAuth.
Enable as Client— If the FortiGate unit is a dialup client, enter the user
name and password that the FortiGate unit will need to authenticate itself
to the remote XAuth server.
Enable as Server— This is available only if Remote Gateway is set to
Dialup User. Dialup clients authenticate as members of a dialup user
group. You must first create a user group for the dialup clients that need
access to the network behind the FortiGate unit.

You must also configure the FortiGate unit to forward authentication
requests to an external RADIUS or LDAP authentication server.

Select a Server Type setting to determine the type of encryption method
to use between the FortiGate unit, the XAuth client and the external
authentication server, and then select the user group from the User Group
list.

Username Enter the user name that is used for authentication.

Password Enter the password that is used for authentication.
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NAT Traversal Select the check box if a NAT device exists between the local FortiGate
unit and the VPN peer or client. The local FortiGate unit and the VPN peer
or client must have the same NAT traversal setting (both selected or both
cleared) to connect reliably.

Additionally, you can force IPsec to use NAT traversal. If NAT is set to
Forced, the FortiGate will use a port value of zero when constructing the
NAT discovery hash for the peer. This causes the peer to think it is behind a
NAT device, and it will use UDP encapsulation for IPsec, even if no NAT is
present. This approach maintains interoperability with any IPsec
implementation that supports the NAT-T RFC.

Keepalive Frequency If you enabled NAT-traversal, enter a keepalive frequency setting.

Dead Peer Detection Select this check box to reestablish VPN tunnels on idle connections and
clean up dead IKE peers if required. You can use this option to receive
notification whenever a tunnel goes up or down, or to keep the tunnel
connection open when no traffic is being generated inside the tunnel. For
example, in scenarios where a dialup client or dynamic DNS peer connects
from an IP address that changes periodically, traffic may be suspended
while the IP address changes.

With Dead Peer Detection selected, you can use the config vpn
ipsec phase1 (tunnel mode) or config vpn ipsec phase1-
interface (interface mode) CLI command to optionally specify a retry
count and a retry interval.

IKEv1 fragmentation

UDP fragmentation can cause issues in IPsec when either the ISP or perimeter firewall(s) cannot pass or
fragment the oversized UDP packets that occur when using a very large public security key (PSK). The result is
that IPsec tunnels do not come up. The solution is IKE fragmentation.

For most configurations, enabling IKE fragmentation allows connections to automatically establish when they
otherwise might have failed due to intermediate nodes dropping IKEmessages containing large certificates,
which typically push the packet size over 1500 bytes.

FortiOS will fragment a packet on sending if, and only if, all the following are true:

l Phase 1 contains "set fragmentation enable".
l The packet is larger than the minimum MTU (576 for IPv4, 1280 for IPv6).
l The packet is being re-transmitted.

By default, IKE fragmentation is enabled, but upon upgrading, any existing phase1-interface may have have "set
fragmentation disable" added in order to preserve the existing behaviour of not supporting fragmentation.

Enabling or disabling IKE fragmentation - CLI

config vpn ipsec phase1-interface
edit 1

set fragmentation [enable | disable]
next

end
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IKEv2 fragmentation

With IKEv2, because RFC 7383 requires each fragment to be individually encrypted and authenticated, we would
have to keep a copy of the unencrypted payloads around for each outgoing packet, in case the original single
packet was never answered and we wanted to retry with fragments. With the following implementation, if the IKE
payloads are greater than a configured threshold, the IKE packets are preemptively fragmented and encrypted.

CLI syntax

config vpn ipsec phase1-interface
edit ike

set ike-version 2
set fragmentation [enable|disable]
set fragmentation-mtu [500-16000]

next
end

Phase 2 configuration
After IPsec Phase 1 negotiations end successfully, you begin Phase 2. You can configure the Phase 2 parameters
to define the algorithms that the FortiGate unit may use to encrypt and transfer data for the remainder of the
session. During Phase 2, you select specific IPsec security associations needed to implement security services
and establish a tunnel.

The basic Phase 2 settings associate IPsec Phase 2 parameters with the Phase 1 configuration that specifies the
remote end point of the VPN tunnel. In most cases, you need to configure only basic Phase 2 settings.

These settings are mainly configured in the CLI, although some options are available after the tunnel is created
using the VPN Creation Wizard (using the Convert to Custom Tunnel option).

Name Type a name to identify the Phase 2 configuration.

Phase 1 Select the Phase 1 tunnel configuration. For more information on
configuring Phase 1, see Phase 1 configuration on page 2035. The Phase 1
configuration describes how remote VPN peers or clients will be
authenticated on this tunnel, and how the connection to the remote peer or
client will be secured.

Advanced Define advanced Phase 2 parameters. For more information, see Phase 2
advanced configuration settings below.

Phase 2 advanced configuration settings

In Phase 2, the FortiGate unit and the VPN peer or client exchange keys again to establish a secure
communication channel between them. You select the encryption and authentication algorithms needed to
generate keys for protecting the implementation details of Security Associations (SAs). These are called Phase 2
Proposal parameters. The keys are generated automatically using a Diffie-Hellman algorithm.

You can use a number of additional advanced Phase 2 settings to enhance the operation of the tunnel.
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Phase 2 Proposal Select the encryption and authentication algorithms that will be proposed
to the remote VPN peer. You can specify up to three proposals. To
establish a VPN connection, at least one of the proposals that you specify
must match configuration on the remote peer.

Initially there are two proposals. Add and Delete icons are next to the
second Authentication field.

It is invalid to set both Encryption and Authentication to NULL.

Encryption Select a symmetric-key algorithms:

NULL— Do not use an encryption algorithm.
DES— Digital Encryption Standard, a 64-bit block algorithm that uses a
56-bit key.
3DES— Triple-DES; plain text is encrypted three times by three keys.
AES128— A128-bit block algorithm that uses a 128-bit key.
AES192— A128-bit block algorithm that uses a 192-bit key.
AES256— A128-bit block algorithm that uses a 256-bit key.

Authentication You can select either of the following message digests to check the
authenticity of messages during an encrypted session:

NULL— Do not use a message digest.
MD5—Message Digest 5.
SHA1— Secure Hash Algorithm 1 - a 160-bit message digest.

To specify one combination only, set the Encryption and Authentication
options of the second combination to NULL. To specify a third
combination, use the Add button beside the fields for the second
combination.

Enable replay detection Replay attacks occur when an unauthorized party intercepts a series of
IPsec packets and replays them back into the tunnel.

Enable perfect forward
secrecy (PFS)

Perfect forward secrecy (PFS) improves security by forcing a new
Diffie-Hellman exchange whenever keylife expires.

Diffie-Hellman Group Select one Diffie-Hellman group (1, 2, 5, or 14 through 21). This must
match the DH Group that the remote peer or dialup client uses.

Keylife Select the method for determining when the Phase 2 key expires:
Seconds, KBytes, orBoth. If you select Both, the key expires when
either the time has passed or the number of KB have been processed.

Autokey Keep Alive Select the check box if you want the tunnel to remain active when no data
is being processed.

Auto-negotiate Enable the option if you want the tunnel to be automatically renegotiated
when the tunnel expires.
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DHCP-IPsec Provide IP addresses dynamically to VPN clients. This is available for
Phase 2 configurations associated with a dialup Phase 1 configuration.

You also need configure a DHCP server or relay on the private network
interface. You must configure the DHCP parameters separately.

If you configure the DHCP server to assign IP addresses based on RADIUS
user group attributes, you must also set the Phase 1 Peer Options to Peer
ID from dialup group and select the appropriate user group. See Phase
1 configuration on page 2035.

If the FortiGate unit acts as a dialup server and you manually assigned
FortiClient dialup clients VIP addresses that match the network behind the
dialup server, selecting the check box will cause the FortiGate unit to act as
a proxy for the dialup clients.

Quick Mode Selector Specify the source and destination IP addresses to be used as selectors for
IKE negotiations. If the FortiGate unit is a dialup server, keep the default
value of 0.0.0.0/0 unless you need to circumvent problems caused by
ambiguous IP addresses between one or more of the private networks
making up the VPN. You can specify a single host IP address, an IP
address range, or a network address. You may optionally specify source
and destination port numbers and a protocol number.

If you are editing an existing Phase 2 configuration, the Source address
and Destination address fields are unavailable if the tunnel has been
configured to use firewall addresses as selectors. This option exists only in
the CLI.

Source address If the FortiGate unit is a dialup server, enter the source IP address that
corresponds to the local senders or network behind the local VPN peer (for
example, 172.16.5.0/24 or 172.16.5.0/255.255.255.0 for a
subnet, or 172.16.5.1/32 or 172.16.5.1/255.255.255.255 for a
server or host, or 192.168.10.[80-100] or 192.168.10.80-
192.168.10.100 for an address range). A value of 0.0.0.0/0 means
all IP addresses behind the local VPN peer.

If the FortiGate unit is a dialup client, source address must refer to the
private network behind the Fortinet dialup client.

Source port Enter the port number that the local VPN peer uses to transport traffic
related to the specified service (protocol number). The range is from 0 to
65535. To specify all ports, type 0.

Destination address Enter the destination IP address that corresponds to the recipients or
network behind the remote VPN peer (for example, 192.168.20.0/24
for a subnet, or 172.16.5.1/32 for a server or host, or 192.168.10.
[80-100] for an address range). A value of 0.0.0.0/0 means all IP
addresses behind the remote VPN peer.
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Destination port Enter the port number that the remote VPN peer uses to transport traffic
related to the specified service (protocol number). To specify all ports,
enter 0.

Protocol Enter the IP protocol number of the service. To specify all services, enter 0.

FortiClient VPN

Use the FortiClient VPN for OS X, Windows, and Android VPNWizard option when configuring an IPsec
VPN for remote users to connect to the VPN tunnel using FortiClient.

When configuring a FortiClient VPN connection, the settings for Phase 1 and Phase 2 settings are automatically
configured by the FortiGate unit. They are set to:

l Remote Gateway— Dialup User
l Mode— Aggressive
l Default settings for Phase 1 and 2 Proposals
l XAUTH Enable as Server (Auto)
l IKEmode-config will be enabled
l Peer Option — “Any peer ID”

The remainder of the settings use the current FortiGate defaults. Note that FortiClient settings need to match
these FortiGate defaults. If you need to configure advanced settings for the FortiClient VPN, you must do so
using the CLI.

Name Enter a name for the FortiClient VPN.

Local Outgoing Interface Select the local outgoing interface for the VPN.

Authentication Method Select the type of authentication used when logging in to the VPN.

Preshared Key If Pre-shared Keywas selected in Authentication Method, enter the
pre-shared key in the field provided.

User Group Select a user group. You can also create a user group from the drop-down
list by selecting Create New.

Address Range Start IP Enter the start IP address for the DHCP address range for the client.

Address Range End IP Enter the end IP address for the address range.

Subnet Mask Enter the subnet mask.

Enable IPv4 Split Tunnel Enabled by default, this option enables the FortiClient user to use the VPN
to access internal resources while other Internet access is not sent over the
VPN, alleviating potential traffic bottlenecks in the VPN connection.
Disable this option to have all traffic sent through the VPN tunnel.

Accessible Networks Select from a list of internal networks that the FortiClient user can access.
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Client Options These options affect how the FortiClient application behaves when
connected to the FortiGate VPN tunnel. When enabled, a check box for the
corresponding option appears on the VPN login screen in FortiClient, and is
not enabled by default.

Save Password - When enabled, if the user selects this option, their
password is stored on the user’s computer and will automatically populate
each time they connect to the VPN.

Auto Connect - When enabled, if the user selects this option, when the
FortiClient application is launched, for example after a reboot or system
startup, FortiClient will automatically attempt to connect to the VPN tunnel.

Always Up (Keep Alive) - When enabled, if the user selects this option,
the FortiClient connection will not shut down. When not selected, during
periods of inactivity, FortiClient will attempt to stay connected every three
minutes for a maximum of 10 minutes.

Endpoint Registration When selected, the FortiGate unit requests a registration key from
FortiClient before a connection can be established. A registration key is
defined by going to System > Advanced.

For more information on FortiClient VPN connections to a FortiGate unit,
see the FortiClient Administration Guide.

DNS Server Select which DNS server to use for this VPN:

Use System DNS— Use the same DNS servers as the FortiGate unit.
These are configured at Network > DNS. This is the default option.
Specify— Specify the IP address of a different DNS server.

Concentrator
In a hub-and-spoke configuration, policy-based VPN connections to a number of remote peers radiate from a
single, central FortiGate unit. Site-to-site connections between the remote peers do not exist; however, you can
establish VPN tunnels between any two of the remote peers through the FortiGate unit’s “hub”.

In a hub-and-spoke network, all VPN tunnels terminate at the hub. The peers that connect to the hub are known
as “spokes”. The hub functions as a concentrator on the network, managing all VPN connections between the
spokes. VPN traffic passes from one tunnel to the other through the hub.

You define a concentrator to include spokes in the hub-and-spoke configuration. You create the concentrator in
VPN > IPsec Concentrator and select Create New. A concentrator configuration specifies which spokes to
include in an IPsec hub-and-spoke configuration.

Concentrator Name Type a name for the concentrator.

Available Tunnels A list of defined IPsec VPN tunnels. Select a tunnel from the list and then
select the right arrow.
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Members A list of tunnels that are members of the concentrator. To remove a tunnel
from the concentrator, select the tunnel and select the left arrow.

IPsec Monitor
You can use the IPsec Monitor to view activity on IPsec VPN tunnels and start or stop those tunnels. The display
provides a list of addresses, proxy IDs, and timeout information for all active tunnels, including tunnel mode and
route-based (interface mode) tunnels.

To view the IPsec monitor, go toMonitor > IPsec Monitor.

Tunnels are considered as "up" if at least one phase 2 selector is active. To avoid
confusion, when a tunnel is down, IPsec Monitor will keep the Phase 2 Selectors
column, but hide it by default and be replaced with Phase 1 status column.

For dialup VPNs, the list provides status information about the VPN tunnels established by dialup clients, and
their IP addresses.

For static IP or dynamic DNS VPNs, the list provides status and IP addressing information about VPN tunnels,
active or not, to remote peers that have static IP addresses or domain names. You can also start and stop
individual tunnels from the list.
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This chapter provides detailed step-by-step procedures for configuring a FortiGate unit to accept a connection
from a remote peer or dialup client. The Phase 1 parameters identify the remote peer or clients and supports
authentication through preshared keys or digital certificates. You can increase access security further using peer
identifiers, certificate distinguished names, group names, or the FortiGate extended authentication (XAuth)
option for authentication purposes.

For more information on Phase 1 parameters in the web-based manager, see IPsec VPN in the web-based
manager on page 2035.

The information and procedures in this section do not apply to VPN peers that perform negotiations using manual
keys.

The following topics are included in this section:

Overview
To configure IPsec Phase 1 settings, go to VPN > IPsec Tunnels and edit the Phase 1 Proposal (if it is not
available, you may need to click the Convert to Custom Tunnel button).

IPsec Phase 1 settings define:

l The remote and local ends of the IPsec tunnel
l If Phase 1 parameters are exchanged in multiple rounds with encrypted authentication information (main mode) or

in a single message with authentication information that is not encrypted (aggressive mode)
l If a preshared key or digital certificates will be used to authenticate the FortiGate unit to the VPN peer or dialup

client
l If the VPN peer or dialup client is required to authenticate to the FortiGate unit. A remote peer or dialup client can

authenticate by peer ID or, if the FortiGate unit authenticates by certificate, it can authenticate by peer certificate.
l The IKE negotiation proposals for encryption and authentication
l Optional XAuth authentication, which requires the remote user to enter a user name and password. A FortiGate

VPN server can act as an XAuth server to authenticate dialup users. A FortiGate unit that is a dialup client can also
be configured as an XAuth client to authenticate itself to the VPN server.

For all the Phase 1 web-based manager fields, see IPsec VPN in the web-based manager on page 2035.

If you want to control how IKE is negotiated when there is no traffic, as well as the length of time the unit waits for
negotiations to occur, use the negotiation-timeout and auto-negotiate commands in the CLI.

Defining the tunnel ends
To begin defining the Phase 1 configuration, go to VPN > IPsec Tunnels and select Create New. Enter a
unique descriptive name for the VPN tunnel and follow the instructions in the VPN Creation Wizard.

The Phase 1 configuration mainly defines the ends of the IPsec tunnel. The remote end is the remote gateway
with which the FortiGate unit exchanges IPsec packets. The local end is the FortiGate interface that sends and
receives IPsec packets.

The remote gateway can be:
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l A static IP address
l A domain name with a dynamic IP address
l A dialup client

A statically addressed remote gateway is the simplest to configure. You specify the IP address. Unless restricted
in the security policy, either the remote peer or a peer on the network behind the FortiGate unit can bring up the
tunnel.

If the remote peer has a domain name and subscribes to a dynamic DNS service, you need to specify only the
domain name. The FortiGate unit performs a DNS query to determine the appropriate IP address. Unless
restricted in the security policy, either the remote peer or a peer on the network behind the FortiGate unit can
bring up the tunnel.

If the remote peer is a dialup client, only the dialup client can bring up the tunnel. The IP address of the client is
not known until it connects to the FortiGate unit. This configuration is a typical way to provide a VPN for client
PCs running VPN client software such as the FortiClient Endpoint Security application.

The local end of the VPN tunnel, the Local Interface, is the FortiGate interface that sends and receives the IPsec
packets. This is usually the public interface of the FortiGate unit that is connected to the Internet (typically the
WAN1 port). Packets from this interface pass to the private network through a security policy.

By default, the local VPN gateway is the IP address of the selected Local Interface. If you are configuring an
interface mode VPN, you can optionally use a secondary IP address of the Local Interface as the local gateway.

Choosing Main mode or Aggressive mode
The FortiGate unit and the remote peer or dialup client exchange Phase 1 parameters in either Main mode or
Aggressive mode. This choice does not apply if you use IKE version 2, which is available only for route-based
configurations.

l InMainmode, the Phase 1 parameters are exchanged in multiple rounds with encrypted authentication information
l In Aggressivemode, the Phase 1 parameters are exchanged in a single message with unencrypted authentication

information.

Although Main mode is more secure, you must select Aggressive mode if there is more than one dialup Phase 1
configuration for the interface IP address, and the remote VPN peer or client is authenticated using an identifier
local ID. Aggressive mode might not be as secure as Main mode, but the advantage to Aggressive mode is that it
is faster than Main mode (since fewer packets are exchanged). Aggressive mode is typically used for remote
access VPNs. But you would also use aggressive mode if one or both peers have dynamic external IP addresses.
Descriptions of the peer options in this guide indicate whether Main or Aggressive mode is required.

Choosing the IKE version
If you create a route-based VPN, you have the option of selecting IKE version 2. Otherwise, IKE version 1 is used.

IKEv2, defined in RFC 4306, simplifies the negotiation process that creates the security association (SA).

If you select IKEv2:

l There is no choice in Phase 1 of Aggressive or Main mode.
l Extended Authentication (XAUTH) is not available.
l You can select only one Diffie-Hellman Group.
l You can utilize EAP and MOBIKE.
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Repeated authentication in IKEv2

This feature provides the option to control whether a device requires its peer to re-authenticate or whether re-key
is sufficient. It does not influence the re-authentication or re-key behavior of the device itself, which is controlled
by the peer (with the default being to re-key). This solution is in response to RFC 4478. As described by the IETF,
"the purpose of this is to limit the time that security associations (SAs) can be used by a third party who has
gained control of the IPsec peer".

Syntax

config vpn ipsec phase1-interface
edit p1

set reauth [enable | disable]
next

end

IKEv2 cookie notification for IKE_SA_INIT

IKEv2 offers an optional exchange within IKE_SA_INIT (the initial exchange between peers when establishing a
secure tunnel) as a result of an inherent vulnerability in IPsec implementations, as described in RFC 5996.

Two expected attacks against IKE are state and CPU exhaustion, where the target is flooded with session
initiation requests from forged IP addresses. These attacks can be made less effective if a responder uses
minimal CPU and commits no state to an SA until it knows the initiator can receive packets at the address from
which it claims to be sending them.

If the IKE_SA_INIT response includes the cookie notification, the initiator MUST then retry the IKE_SA_INIT
request, and include the cookie notification containing the received data as the first payload, and all other
payloads unchanged.

Upon detecting that the number of half-open IKEv2 SAs is above the threshold value, the VPN dialup server
requires all future SA_INIT requests to include a valid cookie notification payload that the server sends back, in
order to preserve CPU and memory resources.

For most devices, the threshold value is set to 500, half of the maximum 1,000 connections.

This feature is enabled by default in FortiOS 5.4.

IKEv2 Quick Crash Detection

There is support for IKEv2 Quick Crash Detection (QCD) as described in RFC 6290.

RFC 6290 describes a method in which an IKE peer can quickly detect that the gateway peer that it has and
established an IKE session with has rebooted, crashed, or otherwise lost IKE state. When the gateway receives
IKEmessages or ESP packets with unknown IKE or IPsec SPIs, the IKEv2 protocol allows the gateway to send
the peer an unprotected IKEmessage containing INVALID_IKE_SPI or INVALID_SPI notification payloads.

RFC 6290 introduces the concept of a QCD token, which is generated from the IKE SPIs and a private QCD
secret, and exchanged between peers during the protected IKE AUTH exchange.

Adding Quick Crash Detection - CLI Syntax

config system settings
set ike-quick-crash-detect [enable | disable]

end
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IKEv1 Quick Crash Detection

Based on the IKEv2 QCD feature described above, IKEv1 QCD is implemented using a new IKE vendor ID,
"Fortinet Quick Crash Detection", and so both endpoints must be FortiGate devices. The QCD token is sent in the
Phase 1 exchange and must be encrypted, so this is only implemented for IKEv1 in Main mode (Aggressive mode
is not supported as there is no available AUTH message in which to include the token).

Otherwise, the feature works the same as in IKEv2 (RFC 6290).

Authenticating the FortiGate unit
The FortiGate unit can authenticate itself to remote peers or dialup clients using either a pre-shared key or an
RSA Signature (certificate).

Authenticating the FortiGate unit with digital certificates

To authenticate the FortiGate unit using digital certificates, you must have the required certificates installed on
the remote peer and on the FortiGate unit. The signed server certificate on one peer is validated by the presence
of the root certificate installed on the other peer. If you use certificates to authenticate the FortiGate unit, you can
also require the remote peers or dialup clients to authenticate using certificates.

Authenticating the FortiGate unit using digital certificates

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button):

Name Enter a name that reflects the origination of the remote connection. For
interface mode, the name can be up to 15 characters long.

Remote Gateway Select the nature of the remote connection.

Each option changes the available fields you must configure. For more
information, see Authenticating the FortiGate unit on page 2051.

Local Interface Select the interface that is the local end of the IPsec tunnel. For more
information, see Authenticating the FortiGate unit on page 2051. The local
interface is typically the WAN1 port.

Mode Select a mode. It is easier to use Aggressive mode.

InMainmode, parameters are exchanged in multiple encrypted rounds.

In Aggressivemode, parameters are exchanged in a single unencrypted
message.

Aggressive mode must be used when the remote VPN peer or client has a
dynamic IP address, or the remote VPN peer or client will be authenticated
using an identifier (local ID).

For more information, see Authenticating the FortiGate unit on page 2051.

Authentication Method Select Signature.
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Certificate Name Select the name of the server certificate that the FortiGate unit will use to
authenticate itself to the remote peer or dialup client during Phase 1
negotiations.

You must obtain and load the required server certificate before this
selection. If you have not loaded any certificates, use the certificate named
Fortinet_Factory.

Peer Options Peer options define the authentication requirements for remote peers or
dialup clients. They are not for your FortiGate unit itself.

See Authenticating the FortiGate unit on page 2051.

Advanced You can use the default settings for most Phase 1 configurations. Changes
are required only if your network requires them. These settings includes
IKE version, DNS server, P1 proposal encryption and authentication
settings, and XAuth settings. See Authenticating the FortiGate unit on
page 2051.

3. If you are configuring authentication parameters for a dialup user group, optionally define extended authentication
(XAuth) parameters in the Advanced section. See Authenticating the FortiGate unit on page 2051.

4. Select OK.

Authenticating the FortiGate unit with a pre-shared key

The simplest way to authenticate a FortiGate unit to its remote peers or dialup clients is by means of a pre-shared
key. This is less secure than using certificates, especially if it is used alone, without requiring peer IDs or
extended authentication (XAuth). Also, you need to have a secure way to distribute the pre-shared key to the
peers.

If you use pre-shared key authentication alone, all remote peers and dialup clients must be configured with the
same pre-shared key. Optionally, you can configure remote peers and dialup clients with unique pre-shared keys.
On the FortiGate unit, these are configured in user accounts, not in the phase_1 settings. For more information,
see Authenticating the FortiGate unit on page 2051.

The pre-shared key must contain at least 6 printable characters and best practices dictate that it be known only to
network administrators. For optimum protection against currently known attacks, the key must consist of a
minimum of 16 randomly chosen alphanumeric characters.

If you authenticate the FortiGate unit using a pre-shared key, you can require remote peers or dialup clients to
authenticate using peer IDs, but not client certificates.

Authenticating the FortiGate unit with a pre-shared key

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button):

Name Enter a name that reflects the origination of the remote connection.

Remote Gateway Select the nature of the remote connection. For more information, see
Authenticating the FortiGate unit on page 2051.
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Local Interface Select the interface that is the local end of the IPsec tunnel. For more
information, see Authenticating the FortiGate unit on page 2051. The local
interface is typically the WAN1 port.

Mode Select Main or Aggressive mode.

InMainmode, the Phase 1 parameters are exchanged in multiple rounds
with encrypted authentication information.

In Aggressivemode, the Phase 1 parameters are exchanged in single
message with authentication information that is not encrypted.

When the remote VPN peer or client has a dynamic IP address, or the
remote VPN peer or client will be authenticated using an identifier (local
ID), you must select Aggressive mode if there is more than one dialup
Phase 1 configuration for the interface IP address.

For more information, see Authenticating the FortiGate unit on page 2051.

Authentication Method Select Pre-shared Key.

Pre-shared Key Enter the preshared key that the FortiGate unit will use to authenticate
itself to the remote peer or dialup client during Phase 1 negotiations. You
must define the same value at the remote peer or client. The key must
contain at least 6 printable characters and best practices dictate that it only
be known by network administrators. For optimum protection against
currently known attacks, the key must consist of a minimum of 16 randomly
chosen alphanumeric characters.

Peer options Peer options define the authentication requirements for remote peers or
dialup clients, not for the FortiGate unit itself. You can require the use of
peer IDs, but not client certificates. For more information, see
Authenticating the FortiGate unit on page 2051.

Advanced You can retain the default settings unless changes are needed to meet
your specific requirements. See Authenticating the FortiGate unit on page
2051.

3. If you are configuring authentication parameters for a dialup user group, optionally define extended authentication
(XAuth) parameters. See Authenticating the FortiGate unit on page 2051.

4. Select OK.

Authenticating remote peers and clients
Certificates or pre-shared keys restrict who can access the VPN tunnel, but they do not identify or authenticate
the remote peers or dialup clients. You have the following options for authentication:
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Methods of authenticating remote VPN peers

Certificates or Pre-shared key Local ID User account pre-shared
keys Reference

Certificates See Enabling VPN
access for specific
certificate holders on
page 2054.

Either X
See Enabling VPN
access by peer identifier
on page 2056.

Pre-shared key X See Enabling VPN
access with user
accounts and pre-shared
keys on page 2057.

Pre-shared key X X

See Enabling VPN
access with user
accounts and pre-shared
keys on page 2057.

Repeated Authentication in Internet Key Exchange (IKEv2) Protocol

This feature provides the option to control whether a device requires its peer to re-authenticate or whether re-key
is sufficient. It does not influence the re-authentication or re-key behavior of the device itself, which is controlled
by the peer (with the default being to re-key).

This solution is in response to RFC 4478. This solution is intended to limit the time that security associations
(SAs) can be used by a third party who has gained control of the IPsec peer.

CLI Syntax:

config vpn ipsec phase1-interface
edit p1

set reauth [enable | disable]
next

end

disable: Disable IKE SA re-authentication.

enable: Enable IKE SA re-authentication.

Enabling VPN access for specific certificate holders

When a VPN peer or dialup client is configured to authenticate using digital certificates, it sends the Distinguished
Name (DN) of its certificate to the FortiGate unit. This DN can be used to allow VPN access for the certificate
holder. That is, a FortiGate unit can be configured to deny connections to all remote peers and dialup clients
except the one having the specified DN.
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Before you begin

The following procedures assume that you already have an existing Phase 1 configuration (see Authenticating
remote peers and clients on page 2053). Follow the procedures below to add certificate-based authentication
parameters to the existing configuration.

Before you begin, you must obtain the certificate DN of the remote peer or dialup client. If you are using the
FortiClient application as a dialup client, refer to FortiClient online help for information about how to view the
certificate DN. To view the certificate DN of a FortiGate unit, see Viewing server certificate information and
obtaining the local DN on page 2055.

Use the config user peer CLI command to load the DN value into the FortiGate configuration. For
example, if a remote VPN peer uses server certificates issued by your own organization, you would enter
information similar to the following:

config user peer
edit DN_FG1000

set cn 192.168.2.160
set cn-type ipv4

end

The value that you specify to identify the entry (for example, DN_FG1000) is displayed in the Accept this peer
certificate only list in the IPsec Phase 1 configuration when you return to the web-based manager.

If the remote VPN peer has a CA-issued certificate to support a higher level of credibility, you would enter
information similar to the following in the CLI:

config user peer
edit CA_FG1000

set ca CA_Cert_1
set subject FG1000_at_site1

end

The value that you specify to identify the entry (for example, CA_FG1000) is displayed in the Accept this peer
certificate only list in the IPsec Phase 1 configuration when you return to the web-based manager. For more
information about these CLI commands, see the “user” chapter of the FortiGate CLI Reference.

A group of certificate holders can be created based on existing user accounts for dialup clients. To create the user
accounts for dialup clients, see the “User” chapter of the FortiGate Administration Guide. To create the certificate
group afterward, use the config user peergrp CLI command. See the “user” chapter of the FortiGate CLI
Reference.

Viewing server certificate information and obtaining the local DN

1. Go to System > Certificates.
2. Note the CN value in the Subject field (for example, CN = 172.16.10.125, CN = info@fortinet.com,

or CN = www.example.com).

Viewing CA root certificate information and obtaining the CA certificate name

1. Go to System > Certificates > CA Certificates.
2. Note the value in the Name column (for example, CA_Cert_1).
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Configuring certificate authentication for a VPN

With peer certificates loaded, peer users and peer groups defined, you can configure your VPN to authenticate
users by certificate.

Enabling access for a specific certificate holder or a group of certificate holders

1. At the FortiGate VPN server, go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing
tunnel.

2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. From the Authentication Method list, select RSA Signature.
4. From the Certificate Name list, select the name of the server certificate that the FortiGate unit will use to

authenticate itself to the remote peer or dialup client
5. Under Peer Options, select one of these options:

l To accept a specific certificate holder, select Accept this peer certificate only and select the name of the
certificate that belongs to the remote peer or dialup client. The certificate DN must be added to the FortiGate
configuration through CLI commands before it can be selected here. See Before you begin on page 2055.

l To accept dialup clients who are members of a certificate group, select Accept this peer certificate group
only and select the name of the group. The group must be added to the FortiGate configuration through CLI
commands before it can be selected here. See Before you begin on page 2055.

6. If you want the FortiGate VPN server to supply the DN of a local server certificate for authentication purposes,
select Advanced and then from the Local ID list, select the DN of the certificate that the FortiGate VPN server is
to use.

7. Select OK.

Enabling VPN access by peer identifier

Whether you use certificates or pre-shared keys to authenticate the FortiGate unit, you can require that remote
peers or clients have a particular peer ID. This adds another piece of information that is required to gain access to
the VPN. More than one FortiGate/FortiClient dialup client may connect through the same VPN tunnel when the
dialup clients share a preshared key and assume the same identifier.

In circumstances where multiple remote dialup VPN tunnels exist, each tunnel must
have a peer ID set.

A peer ID, also called local ID, can be up to 63 characters long containing standard regular expression characters.
Local ID is set in phase1 Aggressive Mode configuration.

You cannot require a peer ID for a remote peer or client that uses a pre-shared key and has a static IP address.

Authenticating remote peers or dialup clients using one peer ID

1. At the FortiGate VPN server, go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing
tunnel.

2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. Select Aggressivemode in any of the following cases:
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l The FortiGate VPN server authenticates a FortiGate dialup client that uses a dedicated tunnel
l A FortiGate unit has a dynamic IP address and subscribes to a dynamic DNS service
l FortiGate/FortiClient dialup clients sharing the same preshared key and local ID connect through the same

VPN tunnel

4. For the Peer Options, select This peer ID and type the identifier into the corresponding field.
5. Select OK.

Assigning an identifier (local ID) to a FortiGate unit

Use this procedure to assign a peer ID to a FortiGate unit that acts as a remote peer or dialup client.

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. Select Advanced.
4. In the Local ID field, type the identifier that the FortiGate unit will use to identify itself.
5. Set Mode to Aggressive if any of the following conditions apply:

l The FortiGate unit is a dialup client that will use a unique ID to connect to a FortiGate dialup server through a
dedicated tunnel.

l The FortiGate unit has a dynamic IP address, subscribes to a dynamic DNS service, and will use a unique ID to
connect to the remote VPN peer through a dedicated tunnel.

l The FortiGate unit is a dialup client that shares the specified ID with multiple dialup clients to connect to a
FortiGate dialup server through the same tunnel.

6. Select OK.

Configuring the FortiClient application

Follow this procedure to add a peer ID to an existing FortiClient configuration:

1. Start the FortiClient application.
2. Go to VPN > Connections, select the existing configuration.
3. Select Advanced > Edit > Advanced.
4. Under Policy, select Config.
5. In the Local ID field, type the identifier that will be shared by all dialup clients. This value must match the This

peer ID value that you specified previously in the Phase 1 gateway configuration on the FortiGate unit.
6. Select OK to close all dialog boxes.
7. Configure all dialup clients the same way using the same preshared key and local ID.

Enabling VPN access with user accounts and pre-shared keys

You can permit access only to remote peers or dialup clients that have pre-shared keys and/or peer IDs
configured in user accounts on the FortiGate unit.

If you want two VPN peers (or a FortiGate unit and a dialup client) to accept reciprocal connections based on peer
IDs, you must enable the exchange of their identifiers when you define the Phase 1 parameters.

The following procedures assume that you already have an existing Phase 1 configuration (see Authenticating
remote peers and clients on page 2053). Follow the procedures below to add ID checking to the existing
configuration.

2057 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Phase 1 parameters

Before you begin, you must obtain the identifier (local ID) of the remote peer or dialup client. If you are using the
FortiClient Endpoint Security application as a dialup client, refer to the Authenticating FortiClient Dialup Clients
Technical Note to view or assign an identifier. To assign an identifier to a FortiGate dialup client or a FortiGate
unit that has a dynamic IP address and subscribes to a dynamic DNS service, see Assigning an identifier (local ID)
to a FortiGate unit on page 2057.

If required, a dialup user group can be created from existing user accounts for dialup clients. To create the user
accounts and user groups, see the User Authentication handbook chapter.

The following procedure supports FortiGate/FortiClient dialup clients that use unique preshared keys and/or peer
IDs. The client must have an account on the FortiGate unit and be a member of the dialup user group.

The dialup user group must be added to the FortiGate configuration before it can be selected. For more
information, see the User Authentication handbook chapter.

The FortiGate dialup server compares the local ID that you specify at each dialup client to the FortiGate user-
account user name. The dialup-client preshared key is compared to a FortiGate user-account password.

Authenticating dialup clients using unique preshared keys and/or peer IDs

1. At the FortiGate VPN server, go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing
tunnel.

2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. If the clients have unique peer IDs, set Mode to Aggressive.
4. Clear the Pre-shared Key field.

The user account password will be used as the preshared key.
5. Select Peer ID from dialup group and then select the group name from the list of user groups.
6. Select OK.
Follow this procedure to add a unique pre-shared key and unique peer ID to an existing FortiClient configuration.

Configuring FortiClient - pre-shared key and peer ID

1. Start the FortiClient Endpoint Security application.
2. Go to VPN > Connections, select the existing configuration.
3. Select Advanced > Edit.
4. In the Preshared Key field, type the FortiGate password that belongs to the dialup client (for example,

1234546).
The user account password will be used as the preshared key.

5. Select Advanced.
6. Under Policy, select Config.
7. In the Local ID field, type the FortiGate user name that you assigned previously to the dialup client (for example,

FortiC1ient1).
8. Select OK to close all dialog boxes.
Configure all FortiClient dialup clients this way using unique preshared keys and local IDs.

Follow this procedure to add a unique pre-shared key to an existing FortiClient configuration.

Configuring FortiClient - preshared key only

1. Start the FortiClient Endpoint Security application.
2. Go to VPN > Connections, select the existing configuration
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3. Select Advanced > Edit.
4. In the Preshared Key field, type the user name, followed by a “+” sign, followed by the password that you

specified previously in the user account settings on the FortiGate unit (for example, FC2+1FG6LK)
5. Select OK to close all dialog boxes.
Configure all the FortiClient dialup clients this way using their unique peer ID and pre-shared key values.

Defining IKE negotiation parameters
In Phase 1, the two peers exchange keys to establish a secure communication channel between them. As part of
the Phase 1 process, the two peers authenticate each other and negotiate a way to encrypt further
communications for the duration of the session. For more information see Defining IKE negotiation parameters
on page 2059. The Phase 1 Proposal parameters select the encryption and authentication algorithms that are
used to generate keys for protecting negotiations.

The IKE negotiation parameters determine:

l Which encryption algorithmsmay be applied for converting messages into a form that only the intended recipient
can read

l Which authentication hash may be used for creating a keyed hash from a preshared or private key
l Which Diffie-Hellman group (DH Group) will be used to generate a secret session key

Phase 1 negotiations (in main mode or aggressive mode) begin as soon as a remote VPN peer or client attempts
to establish a connection with the FortiGate unit. Initially, the remote peer or dialup client sends the FortiGate
unit a list of potential cryptographic parameters along with a session ID. The FortiGate unit compares those
parameters to its own list of advanced Phase 1 parameters and responds with its choice of matching parameters
to use for authenticating and encrypting packets. The two peers handle the exchange of encryption keys between
them, and authenticate the exchange through a preshared key or a digital signature.

Generating keys to authenticate an exchange

The FortiGate unit supports the generation of secret session keys automatically using a Diffie-Hellman algorithm.
These algorithms are defined in RFC 2409. The Keylife setting in the Phase 1 Proposal area determines the
amount of time before the Phase 1 key expires. Phase 1 negotiations are re-keyed automatically when there is an
active security association. See Dead Peer Detection on page 2062.

You can enable or disable automatic re-keying between IKE peers through the phase1-rekey attribute of the
config system global CLI command. For more information, see the “System” chapter of the FortiGate CLI
Reference.

When in FIPS-CC mode, the FortiGate unit requires DH key exchange to use values
at least 3072 bits long. However most browsers need the key size set to 1024. You
can set the minimum size of the DH keys in the CLI.

config system global
   set dh-params 3072
end

When you use a preshared key (shared secret) to set up two-party authentication, the remote VPN peer or client
and the FortiGate unit must both be configured with the same preshared key. Each party uses a session key
derived from the Diffie-Hellman exchange to create an authentication key, which is used to sign a known
combination of inputs using an authentication algorithm (such as HMAC-MD5, HMAC-SHA-1, or HMAC-SHA-
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256). Hash-based Message Authentication Code (HMAC) is a method for calculating an authentication code
using a hash function plus a secret key, and is defined in RFC 2104. Each party signs a different combination of
inputs and the other party verifies that the same result can be computed.

For information regarding NP accelerated offloading of IPsec VPN authentication
algorithms, please refer to the Hardware Acceleration handbook chapter.

When you use preshared keys to authenticate VPN peers or clients, you must distribute matching information to
all VPN peers and/or clients whenever the preshared key changes.

As an alternative, the remote peer or dialup client and FortiGate unit can exchange digital signatures to validate
each other’s identity with respect to their public keys. In this case, the required digital certificates must be
installed on the remote peer and on the FortiGate unit. By exchanging certificate DNs, the signed server
certificate on one peer is validated by the presence of the root certificate installed on the other peer.

The following procedure assumes that you already have a Phase 1 definition that describes how remote VPN
peers and clients will be authenticated when they attempt to connect to a local FortiGate unit. For information
about the Local ID and XAuth options, see Defining IKE negotiation parameters on page 2059 and Defining IKE
negotiation parameters on page 2059. Follow this procedure to add IKE negotiation parameters to the existing
definition.

Defining IKE negotiation parameters

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. Select Phase 1 Proposal and include the appropriate entries as follows:

Phase 1 Proposal Select the encryption and authentication algorithms that will be used to
generate keys for protecting negotiations.

Add or delete encryption and authentication algorithms as required. Select
a minimum of one and a maximum of three combinations. The remote
peer must be configured to use at least one of the proposals that you
define.

It is invalid to set both Encryption and Authentication to null.

Encryption Select a symmetric-key algorithms:

NULL— Do not use an encryption algorithm.
DES— Digital Encryption Standard, a 64-bit block algorithm that uses a
56-bit key.
3DES— Triple-DES; plain text is encrypted three times by three keys.
AES128— A128-bit block algorithm that uses a 128-bit key.
AES192— A128-bit block algorithm that uses a 192-bit key.
AES256— A128-bit block algorithm that uses a 256-bit key.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2060

http://tools.ietf.org/html/rfc2104
https://docs.fortinet.com/document/fortigate/5.6.0/hardware-acceleration


Phase 1 parameters

Authentication You can select either of the following message digests to check the
authenticity of messages during an encrypted session:

NULL— Do not use a message digest.
MD5—Message Digest 5.
SHA1— Secure Hash Algorithm 1 - a 160-bit message digest.

To specify one combination only, set the Encryption and Authentication
options of the second combination to NULL. To specify a third
combination, use the Add button beside the fields for the second
combination.

For information regarding NP accelerated offloading of IPsec VPN
authentication algorithms, please refer to the Hardware Acceleration
handbook chapter.

Diffie-Hellman Group Select one or more Diffie-Hellman groups from DH groups 1, 2, 5, 14
through 21, and 27 through 30. When using aggressive mode, DH groups
cannot be negotiated. By default, DH group 14 is selected, to provide
sufficient protection for stronger cipher suites that include AES and SHA2.
If you select multiple DH groups, the order they appear in the configuration
is the order in which they are negotiates.

If both VPN peers (or a VPN server and its client) have static IP addresses
and use aggressive mode, select a single DH group. The setting on the
FortiGate unit must be identical to the setting on the remote peer or dialup
client.

When the remote VPN peer or client has a dynamic IP address and uses
aggressive mode, select up to three DH groups on the FortiGate unit and
one DH group on the remote peer or dialup client. The setting on the
remote peer or dialup client must be identical to one of the selections on
the FortiGate unit.

If the VPN peer or client employs main mode, you can select multiple DH
groups. At least one of the settings on the remote peer or dialup client must
be identical to the selections on the FortiGate unit.

Keylife Type the amount of time (in seconds) that will be allowed to pass before
the IKE encryption key expires. When the key expires, a new key is
generated without interrupting service. The keylife can be from 120 to
172800 seconds.

Nat-traversal Enable this option if a NAT device exists between the local FortiGate unit
and the VPN peer or client. The local FortiGate unit and the VPN peer or
client must have the same NAT traversal setting (both selected or both
cleared). When in doubt, enable NAT-traversal. See NAT traversal on page
2062.
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Keepalive Frequency If you enabled NAT traversal, enter a keepalive frequency setting. The
value represents an interval from 0 to 900 seconds where the connection
will be maintained with no activity. For additional security this value must
be as low as possible. See NAT keepalive frequency on page 2062.

Dead Peer Detection Enable this option to reestablish VPN tunnels on idle connections and clean
up dead IKE peers if required. This feature minimizes the traffic required to
check if a VPN peer is available or unavailable (dead). See Dead Peer
Detection on page 2062.

NAT traversal

Network Address Translation (NAT) is a way to convert private IP addresses to publicly routable Internet
addresses and vise versa. When an IP packet passes through a NAT device, the source or destination address in
the IP header is modified. FortiGate units support NAT version 1 (encapsulate on port 500 with non-IKEmarker),
version 3 (encapsulate on port 4500 with non-ESPmarker), and compatible versions.

NAT cannot be performed on IPsec packets in ESP tunnel mode because the packets do not contain a port
number. As a result, the packets cannot be demultiplexed. To work around this, the FortiGate unit provides a way
to protect IPsec packet headers from NAT modifications. When the Nat-traversal option is enabled, outbound
encrypted packets are wrapped inside a UDP IP header that contains a port number. This extra encapsulation
allows NAT devices to change the port number without modifying the IPsec packet directly.

To provide the extra layer of encapsulation on IPsec packets, the Nat-traversal option must be enabled whenever
a NAT device exists between two FortiGate VPN peers or a FortiGate unit and a dialup client such as FortiClient.
On the receiving end, the FortiGate unit or FortiClient removes the extra layer of encapsulation before decrypting
the packet.

Additionally, you can force IPsec to use NAT traversal. If NAT is set to Forced, the FortiGate will use a port value
of zero when constructing the NAT discovery hash for the peer. This causes the peer to think it is behind a NAT
device, and it will use UDP encapsulation for IPsec, even if no NAT is present. This approach maintains
interoperability with any IPsec implementation that supports the NAT-T RFC.

NAT keepalive frequency

When a NAT device performs network address translation on a flow of packets, the NAT device determines how
long the new address will remain valid if the flow of traffic stops (for example, the connected VPN peer may be
idle). The device may reclaim and reuse a NAT address when a connection remains idle for too long.

To work around this, when you enable NAT traversal specify how often the FortiGate unit sends periodic
keepalive packets through the NAT device in order to ensure that the NAT address mapping does not change
during the lifetime of a session. To be effective, the keepalive interval must be smaller than the session lifetime
value used by the NAT device.

The keepalive packet is a 138-byte ISAKMP exchange.

Dead Peer Detection

Sometimes, due to routing issues or other difficulties, the communication link between a FortiGate unit and a
VPN peer or client may go down. Packets could be lost if the connection is left to time out on its own. The
FortiGate unit provides a mechanism called Dead Peer Detection (DPD), sometimes referred to as gateway
detection or ping server, to prevent this situation and reestablish IKE negotiations automatically before a
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connection times out: the active Phase 1 security associations are caught and renegotiated (rekeyed) before the
Phase 1 encryption key expires.

By default, Dead Peer Detection sends probe messages every five seconds by default (see dpd-
retryinterval in the FortiGate CLI Reference). If you are experiencing high network traffic, you can
experiment with increasing the ping interval. However longer intervals will require more traffic to detect dead
peers which will result in more traffic.

In the web-based manager, the Dead Peer Detection option can be enabled when you define advanced Phase 1
options. The config vpn ipsec phase1 CLI command supports additional options for specifying a retry
count and a retry interval.

For more information about these commands and the related config router gwdetect CLI command, see
the FortiGate CLI Reference.

For example, enter the following CLI commands to configure dead peer detection on the existing IPsec Phase 1
configuration called test to use 15 second intervals and to wait for 3 missed attempts before declaring the peer
dead and taking action.

config vpn ipsec phase1-interface
edit <value>

set dpd [disable | on-idle | on-demand]
set dpd-retryinveral 15
set dpd-retrycount 3

next
end

DPD Scalability

On a dial-up server, if a multitude of VPN connections are idle, the increased DPD exchange could negatively
impact the performance/load of the daemon. For this reason, an option is available in the CLI to send DPD
passively in a mode called "on-demand".

l When there is no traffic and the last DPD-ACK had been received, IKE will not send
DPDs periodically.

l IKE will only send out DPDs if there are outgoing packets to send but no inbound
packets had since been received.

Syntax

Set DPD to on-demand to trigger DPD when IPsec traffic is sent but no reply is received from the peer.

config vpn ipsec phase1-interface
edit <value>

set dpd [disable | on-idle | on-demand]
next

end

Certificate key size control

Proxy will choose the same SSL key size as the HTTPS server. If the key size from the server is 512, the proxy will
choose 1024. If the key size is bigger than 1024, the proxy will choose 2048.
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As a result, the firewall ssl-ssh-profile commands certname-rsa, certname-dsa, and
certname-ecdsa have been replaced with more specific key size control commands under vpn
certificate setting.

CLI syntax

config vpn certificate setting
set certname-rsa1024 <name>
set certname-rsa2048 <name>
set certname-dsa1024 <name>
set certname-dsa2048 <name>
set certname-ecdsa256 <name>
set certname-ecdsa384 <name>

end

Using XAuth authentication
Extended authentication (XAuth) increases security by requiring the remote dialup client user to authenticate in a
separate exchange at the end of Phase 1. XAuth draws on existing FortiGate user group definitions and uses
established authentication mechanisms such as PAP, CHAP, RADIUS, and LDAP to authenticate dialup clients.
You can configure a FortiGate unit to function either as an XAuth server or an XAuth client.If the server or client is
attempting a connection using XAuth and the other end is not using XAuth, the failed connection attempts that
are logged will not specify XAuth as the reason.

Using the FortiGate unit as an XAuth server

A FortiGate unit can act as an XAuth server for dialup clients. When the Phase 1 negotiation completes, the
FortiGate unit challenges the user for a user name and password. It then forwards the user’s credentials to an
external RADIUS or LDAP server for verification.

If the user records on the RADIUS server have suitably configured Framed-IP-Address fields, you can assign
client virtual IP addresses by XAuth instead of from a DHCP address range. See Assigning VIPs by RADIUS user
group on page 1.

The authentication protocol to use for XAuth depends on the capabilities of the authentication server and the
XAuth client:

l Select PAP Server whenever possible.
l You must select PAP Server for all implementations of LDAP and some implementations of Microsoft RADIUS.
l Select Auto Server when the authentication server supportsCHAP Server but the XAuth client does not. The

FortiGate unit will use PAP to communicate with the XAuth client and CHAP to communicate with the
authentication server. You can also use Auto Server to allows multiple source interfaces to be defined in an
IPsec/IKE policy

Before you begin, create user accounts and user groups to identify the dialup clients that need to access the
network behind the FortiGate dialup server. If password protection will be provided through an external RADIUS
or LDAP server, you must configure the FortiGate dialup server to forward authentication requests to the
authentication server.

Authenticating a dialup user group using XAuth settings

1. At the FortiGate dialup server, go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing
tunnel.

2. Select Convert To Custom Tunnel.
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3. Edit XAUTH, select the Type setting, which determines the type of encryption method to use between the XAuth
client, the FortiGate unit and the authentication server. Select one of the following options:
l Disabled— Disables XAuth settings.
l PAP Server — Password Authentication Protocol.
l CHAP Server — Challenge-Handshake Authentication Protocol.
l Auto Server — Use PAP between the XAuth client and the FortiGate unit, and CHAP between the FortiGate

unit and the authentication server.

4. From the User Group list, select the user group that needs to access the private network behind the FortiGate
unit. The group must be added to the FortiGate configuration before it can be selected here. For multiple user
groups to be defined in the IPsec/IKE policy, select Inherit from policy.

4. Select OK.
5. Create as many policies as needed, specifying Source User(s) and Destination Address.

For example, one policy could have user1 have access to test_local_subnet_1, while user2 has access to test_
local_subnet_2.

As of FortiOS 5.4.1, when XAuth settings are enabled, Inherit from policy is only
available under PAP Server and CHAP Server, not Auto Server. Because of this,
only one user group may be defined forAuto Server.

Using the FortiGate unit as an XAuth client

If the FortiGate unit acts as a dialup client, the remote peer, acting as an XAuth server, might require a username
and password. You can configure the FortiGate unit as an XAuth client, with its own username and password,
which it provides when challenged.

Configuring the FortiGate dialup client as an XAuth client

1. At the FortiGate dialup client, go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing
tunnel.

2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. Under XAuth, select Enable as Client.
4. In the Username field, type the FortiGate PAP, CHAP, RADIUS, or LDAP user name that the FortiGate XAuth

server will compare to its records when the FortiGate XAuth client attempts to connect.
5. In the Password field, type the password to associate with the user name.
6. Select OK.

Dynamic IPsec route control
You can add a route to a peer destination selector by using the add-route option, which is available for all
dynamic IPsec Phases 1 and 2, for both policy-based and route-based IPsec VPNs. This option was previously
only available when mode-cfg was enabled in Phase 1.

The add-route option adds a route to the FortiGate unit’s routing information base when the dynamic tunnel is
negotiated. You can use the distance and priority options to set the distance and priority of this route. If this
results in a route with the lowest distance, it is added to the FortiGate unit’s forwarding information base.
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You can also enable add-route in any policy-based or route-based Phase 2 configuration that is associated with a
dynamic (dialup) Phase 1. In Phase 2, add-route can be enabled, disabled, or set to use the same route as Phase
1.

The add-route feature is enabled by default and is configured in the CLI.

Syntax

Phase 1

config vpn ipsec
edit <name>

set type dynamic
set add-route {enable | disable}

end
end

Phase 2

config vpn ipsec {phase2 | phase2-interface}
edit <name>

set add-route {phase1 | enable | disable}
end

end

Blocking IPsec SA Negotiation

For interface-based IPsec, IPsec SA negotiation blocking can only be removed if the peer offers a wildcard
selector. If a wildcard selector is offered then the wildcard route will be added to the routing table with the
distance/priority value configured in Phase 1 and, if that is the route with the lowest distance, it is installed into
the forwarding information base.

In cases where this occurs, it is important to ensure that the distance value configured on Phase 1 is set
appropriately.
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This section describes the Phase 2 parameters that are required to establish communication through a VPN.

The following topics are included in this section:

Phase 2 settings
After IPsec VPN Phase 1 negotiations complete successfully, Phase 2 negotiation begins. Phase 2 parameters
define the algorithms that the FortiGate unit can use to encrypt and transfer data for the remainder of the
session. The basic Phase 2 settings associate IPsec Phase 2 parameters with a Phase 1 configuration.

When defining Phase 2 parameters, you can choose any set of Phase 1 parameters to set up a secure connection
and authenticate the remote peer.

For more information on Phase 2 settings in the web-based manager, see IPsec VPN in the web-based manager
on page 2035.

The information and procedures in this section do not apply to VPN peers that perform negotiations using manual
keys.

Phase 2 Proposals

In Phase 2, the VPN peer or client and the FortiGate unit exchange keys again to establish a secure
communication channel. The Phase 2 Proposal parameters select the encryption and authentication algorithms
needed to generate keys for protecting the implementation details of Security Associations (SAs). The keys are
generated automatically using a Diffie-Hellman algorithm.

Replay Detection

IPsec tunnels can be vulnerable to replay attacks. Replay Detection enables the FortiGate unit to check all IPsec
packets to see if they have been received before. If any encrypted packets arrive out of order, the FortiGate unit
discards them.

IKE/IPsec Extended Sequence Number (ESN) support

64-bit Extended Sequence numbers (as described in RFC 4303, RFC 4304 as an addition to IKEv1, and RFC
5996 for IKEv2.) are supported for IPsec when Replay Detection is enabled.

Perfect Forward Secrecy (PFS)

By default, Phase 2 keys are derived from the session key created in Phase 1. Perfect Forward Secrecy (PFS)
forces a new Diffie-Hellman exchange when the tunnel starts and whenever the Phase 2 keylife expires, causing
a new key to be generated each time. This exchange ensures that the keys created in Phase 2 are unrelated to
the Phase 1 keys or any other keys generated automatically in Phase 2.

Keylife

The Keylife setting sets a limit on the length of time that a Phase 2 key can be used. The default units are
seconds. Alternatively, you can set a limit on the number of kilobytes (KB) of processed data, or both. If you select
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both, the key expires when either the time has passed or the number of KB have been processed. When the
Phase 2 key expires, a new key is generated without interrupting service.

Quick mode selectors

Quick mode selectors determine which IP addresses can perform IKE negotiations to establish a tunnel. By only
allowing authorized IP addresses access to the VPN tunnel, the network is more secure.

The default settings are as broad as possible: any IP address or configured address object, using any protocol, on
any port.

While the drop down menus for specifying an address also show address groups, the use of
address groups may not be supported on a remote endpoint device that is not a FortiGate.

The address groups are at the bottom of the list to make it easy to distinguish between
addresses and address groups.

When configuring Quick Mode selector Source address and Destination address, valid options include IPv4
and IPv6 single addresses, IPv4 subnet, or IPv6 subnet. For more information on IPv6 IPsec VPN, see Overview
of IPv6 IPsec support on page 1.

There are some configurations that require specific selectors:

l The VPN peer is a third-party device that uses specific phase2 selectors.
l The FortiGate unit connects as a dialup client to another FortiGate unit, in which case (usually) you must specify a

source IP address, IP address range, or subnet. However, this is not required if you are using dynamic routing and
mode-cfg.

With FortiOS VPNs, your network has multiple layers of security, with quick mode selectors being an important
line of defence.

l Routes guide traffic from one IP address to another.
l Phase 1 and Phase 2 connection settings ensure there is a valid remote end point for the VPN tunnel that agrees on

the encryption and parameters.
l Quick mode selectors allow IKE negotiations only for allowed peers.
l Security policies control which IP addresses can connect to the VPN.
l Security policies also control what protocols are allowed over the VPN along with any bandwidth limiting.

FortiOS is limited with IKEv2 selector matching. When using IKEv2 with a named
traffic selector, no more than 32 subnets per traffic selector are added, since FortiOS
doesn't fully implement the IKEv2 selector matching rules.

The workaround is to use multiple Phase 2s. If the configuration is FGT <-> FGT, then
the better alternative is to just use 0.0.0.0 <-> 0.0.0.0 and use the firewall policy for
enforcement.

Using the add-route option

Consider using the add-route option to add a route to a peer destination selector. Phase 2 includes the option
of allowing the add-route to automatically match the settings in Phase 1. For more information, refer to Phase
1 parameters on page 2048.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2068



Phase 2 parameters

Syntax

Phase 2

config vpn ipsec {phase2 | phase2-interface}
edit <name>

set add-route {phase1 | enable | disable}
end

end

Configuring the Phase 2 parameters
If you are creating a hub-and-spoke configuration or an Internet-browsing configuration, you may have already
started defining some of the required Phase 2 parameters. If so, edit the existing definition to complete the
configuration.

Specifying the Phase 2 parameters

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Open the Phase 2 Selectors panel (if it is not available, you may need to click the Convert to Custom Tunnel

button).
3. Enter a Name for the Phase 2 configuration, and select a Phase 1 configuration from the drop-down list.
4. Select Advanced.
5. Include the appropriate entries as follows:

Phase 2 Proposal Select the encryption and authentication algorithms that will be used to
change data into encrypted code.

Add or delete encryption and authentication algorithms as required. Select
a minimum of one and a maximum of three combinations. The remote
peer must be configured to use at least one of the proposals that you
define.

It is invalid to set both Encryption and Authentication to null.

Encryption Select a symmetric-key algorithms:

NULL— Do not use an encryption algorithm.
DES— Digital Encryption Standard, a 64-bit block algorithm that uses a
56-bit key.
3DES— Triple-DES; plain text is encrypted three times by three keys.
AES128— A128-bit block algorithm that uses a 128-bit key.
AES192— A128-bit block algorithm that uses a 192-bit key.
AES256— A128-bit block algorithm that uses a 256-bit key.
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Authentication You can select either of the following message digests to check the
authenticity of messages during an encrypted session:

NULL— Do not use a message digest.
MD5—Message Digest 5.
SHA1— Secure Hash Algorithm 1 - a 160-bit message digest.

To specify one combination only, set the Encryption and Authentication
options of the second combination to NULL. To specify a third
combination, use the Add button beside the fields for the second
combination.

For information regarding NP accelerated offloading of IPsec VPN
authentication algorithms, please refer to the Hardware Acceleration
handbook chapter.

Enable replay detection Optionally enable or disable replay detection. Replay attacks occur when
an unauthorized party intercepts a series of IPsec packets and replays
them back into the tunnel.

Enable perfect forward
secrecy (PFS)

Enable or disable PFS. Perfect forward secrecy (PFS) improves security by
forcing a new Diffie-Hellman exchange whenever keylife expires.

Diffie-Hellman Group Select one Diffie-Hellman group (1, 2, 5, 14 through 21, or 27 through 30).
The remote peer or dialup client must be configured to use the same
group.

Keylife Select the method for determining when the Phase 2 key expires:
Seconds, KBytes, orBoth. If you select Both, the key expires when
either the time has passed or the number of KB have been processed. The
range is from 120 to 172800 seconds, or from 5120 to 2147483648 KB.

Autokey Keep Alive Enable the option if you want the tunnel to remain active when no data is
being processed.

Auto-negotiate Enable the option if you want the tunnel to be automatically renegotiated
when the tunnel expires.

DHCP-IPsec Select Enable if the FortiGate unit acts as a dialup server and FortiGate
DHCP server or relay will be used to assign VIP addresses to FortiClient
dialup clients. The DHCP server or relay parameters must be configured
separately.

If the FortiGate unit acts as a dialup server and the FortiClient dialup client
VIP addresses match the network behind the dialup server, select Enable
to cause the FortiGate unit to act as a proxy for the dialup clients.

This is available only for Phase 2 configurations associated with a dialup
Phase 1 configuration. It works only on policy-based VPNs.
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Autokey Keep Alive

The Phase 2 SA has a fixed duration. If there is traffic on the VPN as the SA nears expiry, a new SA is negotiated
and the VPN switches to the new SAwithout interruption. If there is no traffic, however, the SA expires (by
default) and the VPN tunnel goes down. A new SAwill not be generated until there is traffic.

The Autokey Keep Alive option ensures that a new Phase 2 SA is negotiated, even if there is no traffic, so that the
VPN tunnel stays up.

Auto-negotiate

By default, the Phase 2 security association (SA) is not negotiated until a peer attempts to send data. The
triggering packet and some subsequent packets are dropped until the SA is established. Applications normally
resend this data, so there is no loss, but there might be a noticeable delay in response to the user.

If the tunnel goes down, the auto-negotiate feature (when enabled) attempts to re-establish the tunnel. Auto-
negotiate initiates the Phase 2 SA negotiation automatically, repeating every five seconds until the SA is
established.

Automatically establishing the SA can be important for a dialup peer. It ensures that the VPN tunnel is available
for peers at the server end to initiate traffic to the dialup peer. Otherwise, the VPN tunnel does not exist until the
dialup peer initiates traffic.

The auto-negotiate feature is available through the Command Line Interface (CLI) via the following commands:

config vpn ipsec phase2
edit <phase2_name>

set auto-negotiate enable
end

Installing dynamic selectors via auto-negotiate

The IPsec SA connect message generated is used to install dynamic selectors. These selectors can now be
installed via the auto-negotiate mechanism. When phase 2 has auto-negotiate enabled, and phase 1 has mesh-
selector-type set to subnet, a new dynamic selector will be installed for each combination of source and
destination subnets. Each dynamic selector will inherit the auto-negotiate option from the template selector and
begin SA negotiation. Phase 2 selector sources from dial-up clients will all establish SAs without traffic being
initiated from the client subnets to the hub.

DHCP-IPsec

Select this option if the FortiGate unit assigns VIP addresses to FortiClient dialup clients through a DHCP server
or relay. This option is available only if the Remote Gateway in the Phase 1 configuration is set to Dialup User
and it works only on policy-based VPNs.

With the DHCP-IPsec option, the FortiGate dialup server acts as a proxy for FortiClient dialup clients that have
VIP addresses on the subnet of the private network behind the FortiGate unit. In this case, the FortiGate dialup
server acts as a proxy on the local private network for the FortiClient dialup client. When a host on the network
behind the dialup server issues an ARP request that corresponds to the device MAC address of the FortiClient
host (when a remote server sends an ARP to the local FortiClient dialup client), the FortiGate unit answers the
ARP request on behalf of the FortiClient host and forwards the associated traffic to the FortiClient host through
the tunnel.
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This feature prevents the VIP address assigned to the FortiClient dialup client from causing possible arp
broadcast problems— the normal and VIP addresses can confuse some network switches by two addresses
having the same MAC address.
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This section explains how to specify the source and destination IP addresses of traffic transmitted through an
IPsec VPN, and how to define appropriate security policies.

The following topics are included in this section:

Defining policy addresses
A VPN tunnel has two end points. These end points may be VPN peers such as two FortiGate gateways.
Encrypted packets are transmitted between the end points. At each end of the VPN tunnel, a VPN peer intercepts
encrypted packets, decrypts the packets, and forwards the decrypted IP packets to the intended destination.

You need to define firewall addresses for the private networks behind each peer. You will use these addresses as
the source or destination address depending on the security policy.

Example topology for the following policies

In general:
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l In a gateway-to-gateway, hub-and-spoke, dynamic DNS, redundant-tunnel, or transparent configuration, you need
to define a policy address for the private IP address of the network behind the remote VPN peer (for example,
192.168.10.0/255.255.255.0 or 192.168.10.0/24).

l In a peer-to-peer configuration, you need to define a policy address for the private IP address of a server or host
behind the remote VPN peer (for example, 172.16.5.1/255.255.255.255 or 172.16.5.1/32 or
172.16.5.1).

For a FortiGate dialup server in a dialup-client or Internet-browsing configuration:

l If you are not using VIP addresses, or if the FortiGate dialup server assigns VIP addresses to FortiClient dialup
clients through FortiGate DHCP relay, select the predefined destination address “all” in the security policy to refer to
the dialup clients.

l If you assign VIP addresses to FortiClient dialup clients manually, you need to define a policy address for the VIP
address assigned to the dialup client (for example, 10.254.254.1/32), or a subnet address from which the VIP
addresses are assigned (for example, 10.254.254.0/24 or 10.254.254.0/255.255.255.0).

l For a FortiGate dialup client in a dialup-client or Internet-browsing configuration, you need to define a policy
address for the private IP address of a host, server, or network behind the FortiGate dialup server.

Defining a security IP address

1. Go to Policy & Objects > Addresses and select Create New.
2. In the Name field, type a descriptive name that represents the network, server(s), or host(s).
3. In Type, select Subnet.
4. In the Subnet/IP Range field, type the corresponding IP address and subnet mask.

For a subnet you could use the format 172.16.5.0/24 or its equivalent 172.16.5.0/255.255.255.0. For
a server or host it would likely be 172.16.5.1/32. Alternately you can use an IP address range such as
192.168.10.[80-100] or 192.168.10.80-192.168.10.100.

5. Select OK.

Defining security policies for policy-based and route-based VPNs
Security policies allow IP traffic to pass between interfaces on a FortiGate unit. You can limit communication to
particular traffic by specifying source address and destination addresses. Then only traffic from those addresses
will be allowed.

Policy-based and route-based VPNs require different security policies.

l A policy-based VPN requires an IPsec security policy. You specify the interface to the private network, the interface
to the remote peer and the VPN tunnel. A single policy can enable traffic inbound, outbound, or in both directions.

l A route-based VPN requires an Accept security policy for each direction. As source and destination interfaces, you
specify the interface to the private network and the virtual IPsec interface (Phase 1 configuration) of the VPN. The
IPsec interface is the destination interface for the outbound policy and the source interface for the inbound policy.
One security policy must be configured for each direction of each VPN interface.

There are examples of security policies for both policy-based and route-based VPNs throughout this guide. See
Route-based or policy-based VPN on page 2113.

If the security policy, which grants the VPN Connection is limited to certain services,
DHCPmust be included, otherwise the client won’t be able to retrieve a lease from the
FortiGate’s (IPsec) DHCP server, because the DHCPRequest (coming out of the
tunnel) will be blocked.
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Policy-based VPN

An IPsec security policy enables the transmission and reception of encrypted packets, specifies the permitted
direction of VPN traffic, and selects the VPN tunnel. In most cases, a single policy is needed to control both
inbound and outbound IP traffic through a VPN tunnel. Be aware of the following considerations below before
creating an IPsec security policy.

Allow traffic to be initiated from the remote site

Security policies specify which IP addresses can initiate a tunnel. By default, traffic from the local private network
initiates the tunnel. When the Allow traffic to be initiated form the remote site option is selected, traffic
from a dialup client, or a computer on a remote network, initiates the tunnel. Both can be enabled at the same
time for bi-directional initiation of the tunnel.

Outbound and inbound NAT

When a FortiGate unit operates in NAT mode, you can also enable inbound or outbound NAT. Outbound NAT
may be performed on outbound encrypted packets or IP packets in order to change their source address before
they are sent through the tunnel. Inbound NAT is performed to intercept and decrypt emerging IP packets from
the tunnel.

By default, these options are not selected in security policies and can only be set through the CLI. For more
information on this, see the “config firewall” chapter of the FortiGate CLI Reference.

Source and destination addresses

Most security policies control outbound IP traffic. A VPN outbound policy usually has a source address originating
on the private network behind the local FortiGate unit, and a destination address belonging to a dialup VPN client
or a network behind the remote VPN peer. The source address that you choose for the security policy identifies
from where outbound cleartext IP packets may originate, and also defines the local IP address or addresses that
a remote server or client will be allowed to access through the VPN tunnel. The destination address that you
choose identifies where IP packets must be forwarded after they are decrypted at the far end of the tunnel, and
determines the IP address or addresses that the local network will be able to access at the far end of the tunnel.

Enabling other policy features

You can fine-tune a policy for services such as HTTP, FTP, and POP3, enable logging, traffic shaping, antivirus
protection, web filtering, email filtering, file transfer, email services, and optionally allow connections according to
a predefined schedule.

As an option, differentiated services (diffserv or DSCP) for the security policy can be enabled through the CLI. For
more information on this feature, see the Traffic Shaping handbook chapter, or the “firewall” chapter of the
FortiGate CLI Reference.

Before you begin

Before you define the IPsec policy, you must:

l Define the IP source and destination addresses. See Defining policy addresses on page 2073.
l Specify the Phase 1 authentication parameters. See Phase 1 parameters on page 2048.
l Specify the Phase 2 parameters. See Phase 2 parameters on page 2067.
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Defining an IPsec security policy

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New and set the following options:

Name Enter a name for the security policy.

Incoming Interface Select the local interface to the internal (private) network.

Outgoing Interface Select the local interface to the external (public) network.

Source Select the name that corresponds to the local network, server(s), or host(s)
from which IP packets may originate.

Destination Address Select the name that corresponds to the remote network, server(s), or host
(s) to which IP packets may be delivered.

Schedule Keep the default setting (always) unless changes are needed to meet
specific requirements.

Service Keep the default setting (ALL) unless changes are needed to meet your
specific requirements.

Action For the purpose of this configuration, set Action to IPsec. Doing this will
close Firewall / Network Options and open VPN Tunnel options. Select the
VPN tunnel of your choice, and select Allow traffic to be initiated from
the remote site, which will allow traffic from the remote network to initiate
the tunnel.

3. You may enable UTM features, and/or event logging, or select advanced settings to authenticate a user group, or
shape traffic. For more information, see the Firewall handbook chapter.

4. Select OK.
5. Place the policy in the policy list above any other policies having similar source and destination addresses.

Defining multiple IPsec policies for the same tunnel

You must define at least one IPsec policy for each VPN tunnel. If the same remote server or client requires access
to more than one network behind a local FortiGate unit, the FortiGate unit must be configured with an IPsec
policy for each network. Multiple policies may be required to configure redundant connections to a remote
destination or control access to different services at different times.

To ensure a secure connection, the FortiGate unit must evaluate policies with Action set to IPsec before
ACCEPT and DENY. Because the FortiGate unit reads policies starting at the top of the list, you must move all
IPsec policies to the top of the list, and be sure to reorder your multiple IPsec policies that apply to the tunnel so
that specific constraints can be evaluated before general constraints.

Adding multiple IPsec policies for the same VPN tunnel can cause conflicts if the
policies specify similar source and destination addresses, but have different settings
for the same service. When policies overlap in this manner, the system may apply the
wrong IPsec policy or the tunnel may fail.
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For example, if you create two equivalent IPsec policies for two different tunnels, it does not matter which one
comes first in the list of IPsec policies— the system will select the correct policy based on the specified source
and destination addresses. If you create two different IPsec policies for the same tunnel (that is, the two policies
treat traffic differently depending on the nature of the connection request), you might have to reorder the IPsec
policies to ensure that the system selects the correct IPsec policy.

Route-based VPN

When you define a route-based VPN, you create a virtual IPsec interface on the physical interface that connects
to the remote peer. You create ordinary Accept security policies to enable traffic between the IPsec interface and
the interface that connects to the private network. This makes configuration simpler than for policy-based VPNs,
which require IPsec security policies.

Defining security policies for a route-based VPN

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New and define an ACCEPT security policy to permit communication between the local private

network and the private network behind the remote peer. Enter these settings in particular:

Name Enter a name for the security policy.

Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Outgoing Interface Select the IPsec Interface you configured.

Source Select the address name that you defined for the private network behind
this FortiGate unit.

Destination Address Select the address name that you defined for the private network behind
the remote peer.

Action Select ACCEPT.

NAT Disable NAT.

To permit the remote client to initiate communication, you need to define a security policy for
communication in that direction.

3. Select Create New and enter these settings in particular:

Name Enter a name for the security policy.

Incoming Interface Select the IPsec Interface you configured.

Outgoing Interface Select the interface that connects to the private network behind this
FortiGate unit.

Source Select the address name that you defined for the private network behind
the remote peer.

2077 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Defining VPN security policies

Destination Address Select the address name that you defined for the private network behind
this FortiGate unit.

Action Select ACCEPT.

NAT Disable NAT.
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Gateway-to-gateway

This section explains how to set up a basic gateway-to-gateway (site-to-site) IPsec VPN.

The following topics are included in this section:

Configuration overview
In a gateway-to-gateway configuration, two FortiGate units create a VPN tunnel between two separate private
networks. All traffic between the two networks is encrypted and protected by FortiGate security policies.

Example gateway-to-gateway configuration

In some cases, computers on the private network behind one VPN peer may (by co-incidence) have IP addresses
that are already used by computers on the network behind the other VPN peer. In this type of situation
(ambiguous routing), conflicts may occur in one or both of the FortiGate routing tables and traffic destined for the
remote network through the tunnel may not be sent. To resolve issues related to ambiguous routing, see
Configuration overview on page 2079.

In other cases, computers on the private network behind one VPN peer may obtain IP addresses from a local
DHCP server. However, unless the local and remote networks use different private network address spaces,
unintended ambiguous routing and/or IP-address overlap issues may arise. For a discussion of the related issues,
see FortiGate dialup-client configurations on page 1.
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You can set up a fully meshed or partially meshed configuration (see below).

Fully meshed configuration

In a fully meshed network, all VPN peers are connected to each other, with one hop between peers. This topology
is the most fault-tolerant: if one peer goes down, the rest of the network is not affected. This topology is difficult
to scale because it requires connections between all peers. In addition, unnecessary communication can occur
between peers. Best practices dictates a hub-and-spoke configuration instead (see Hub-and-spoke configurations
on page 1).
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Partially meshed configuration

A partially meshed network is similar to a fully meshed network, but instead of having tunnels between all peers,
tunnels are only configured between peers that communicate with each other regularly.

Gateway-to-gateway configuration
The FortiGate units at both ends of the tunnel must be operating in NAT mode and have static public IP
addresses.

When a FortiGate unit receives a connection request from a remote VPN peer, it uses IPsec Phase 1 parameters
to establish a secure connection and authenticate that VPN peer. Then, if the security policy permits the
connection, the FortiGate unit establishes the tunnel using IPsec Phase 2 parameters and applies the IPsec
security policy. Key management, authentication, and security services are negotiated dynamically through the
IKE protocol.

To support these functions, the following general configuration steps must be performed by both FortiGate units:

l Define the Phase 1 parameters that the FortiGate unit needs to authenticate the remote peer and establish a
secure connection.

l Define the Phase 2 parameters that the FortiGate unit needs to create a VPN tunnel with the remote peer.
l Create security policies to control the permitted services and permitted direction of traffic between the IP source

and destination addresses.
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Configuring Phase 1 and Phase 2 for both peers

This procedure applies to both peers. Repeat the procedure on each FortiGate unit, using the correct IP address
for each. You may wish to vary the Phase 1 names but this is optional. Otherwise all steps are the same for each
peer.

The Phase 1 configuration defines the parameters that FortiGate_1 will use to authenticate FortiGate_2 and
establish a secure connection. For the purposes of this example, a preshared key will be used to authenticate
FortiGate_2. The same preshared key must be specified at both FortiGate units.

Before you define the Phase 1 parameters, you need to:

l Reserve a name for the remote gateway.
l Obtain the IP address of the public interface to the remote peer.
l Reserve a unique value for the preshared key.

The key must contain at least 6 printable characters and best practices dictate that it only be known by network
administrators. For optimum protection against currently known attacks, the key must have a minimum of 16
randomly chosen alphanumeric characters.

At the local FortiGate unit, define the Phase 1 configuration needed to establish a secure connection with the
remote peer. See IPsec VPN in the web-based manager on page 2035.

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. Enter the following information, and select OK.

Name Enter peer_1.

A name to identify the VPN tunnel. This name appears in Phase 2
configurations, security policies and the VPNmonitor.

Remote Gateway Select Static IP Address.

IP Address Enter 172.20.0.2 when configuring FortiGate_1.

Enter 172.18.0.2 when configuring FortiGate_2.

The IP address of the remote peer public interface.

Local Interface Select wan1.

The basic Phase 2 settings associate IPsec Phase 2 parameters with the Phase 1 configuration and specify the
remote end point of the VPN tunnel. Before you define the Phase 2 parameters, you need to reserve a name for
the tunnel. See IPsec VPN in the web-based manager on page 2035.

1. Open the Phase 2 Selectors panel (if it is not available, you may need to click the Convert to Custom Tunnel
button).

2. Enter a Name of peer_1_p2.
3. Select peer_1 from the Phase 1 drop-down menu.

Creating security policies

Security policies control all IP traffic passing between a source address and a destination address.
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An IPsec security policy is needed to allow the transmission of encrypted packets, specify the permitted direction
of VPN traffic, and select the VPN tunnel that will be subject to the policy. A single policy is needed to control both
inbound and outbound IP traffic through a VPN tunnel.

Before you define security policies, you must first specify the IP source and destination addresses. In a gateway-
to-gateway configuration:

l The IP source address corresponds to the private network behind the local FortiGate unit.
l The IP destination address refers to the private network behind the remote VPN peer.

When you are creating security policies, choose one of either route-based or policy-based methods and follow it
for both VPN peers. DO NOT configure both route-based and policy-based policies on the same FortiGate unit for
the same VPN tunnel.

The configuration of FortiGate_2 is similar to that of FortiGate_1. You must:

l Define the Phase 1 parameters that FortiGate_2 needs to authenticate FortiGate_1 and establish a secure
connection.

l Define the Phase 2 parameters that FortiGate_2 needs to create a VPN tunnel with FortiGate_1.
l Create the security policy and define the scope of permitted services between the IP source and destination

addresses.

When creating security policies it is good practice to include a comment describing what the policy does.

Creating firewall addresses

Define names for the addresses or address ranges of the private networks that the VPN links. These addresses
are used in the security policies that permit communication between the networks.

To define the IP address of the network behind FortiGate_1

1. Go to Policy & Objects > Addresses and select Create New.
2. Enter the Name of Finance_network.
3. Select a Type of Subnet.
4. Enter the Subnet of 10.21.101.0/24.
5. Select OK.

To specify the address of the network behind FortiGate_2

1. Go to Policy & Objects > Addresses and select Create New.
2. Enter the Name of HR_network.
3. Select a Type of Subnet.
4. Enter the Subnet/IP Range of 10.31.101.0/24.
5. Select OK.

Creating route-based VPN security policies

Define an ACCEPT security policy to permit communications between the source and destination addresses.

To create route-based VPN security policies

1. Go to Policy & Objects > IPv4 Policy and select Create New
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
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3. Enter the following, and select OK.

Incoming Interface Select internal.

The interface that connects to the private network behind this FortiGate
unit.

Source Address Select Finance_networkwhen configuring FortiGate_1.

Select HR_networkwhen configuring FortiGate_2.

The address name for the private network behind this FortiGate unit.

Outgoing Interface Select peer_1.

The VPN Tunnel (IPsec Interface) you configured earlier.

Destination Address Select HR_networkwhen configuring FortiGate_1.

Select Finance_networkwhen configuring FortiGate_2.

The address name that you defined for the private network behind the
remote peer.

Action Select ACCEPT.

Enable NAT Disable.

Comments Allow Internal to remote VPN network traffic.

4. Optionally, configure any additional features you may want, such as UTM or traffic shaping.
5. Select Create New to create another policy for the other direction.
6. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
7. Enter the following information, and select OK.

Incoming Interface Select peer_1.

The VPN Tunnel (IPsec Interface) you configured.

Source Address Select HR_networkwhen configuring FortiGate_1.

Select Finance_Networkwhen configuring FortiGate_2.

The address name defined for the private network behind the remote
peer.

Outgoing Interface Select internal.

The interface that connects to the private network behind this FortiGate
unit.
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Destination Address Select Finance_Networkwhen configuring FortiGate_1.

Select HR_networkwhen configuring FortiGate_2.

The address name defined for the private network behind this FortiGate
unit.

Action Select ACCEPT.

Enable NAT Disable.

Comments Allow remote VPN network traffic to Internal.

8. Configure any additional features such as UTM or traffic shaping you may want. (optional).
All network traffic must have a static route to direct its traffic to the proper destination. Without a route, traffic will
not flow even if the security policies are configured properly. You may need to create a static route entry for both
directions of VPN traffic if your security policies allow bi-directional tunnel initiation.

To configure the route for a route-based VPN:

1. On FortiGate_2, go to Network > Static Routes and select Create New.
2. Enter the following information, and then select OK:

Destination IP / Mask 10.21.101.0/24

Device FGT2_to_FGT1_Tunnel

Gateway Leave as default: 0.0.0.0.

Distance (Advanced) Leave this at its default.

If there are other routes on this FortiGate unit, you may need to set the
distance on this route so the VPN traffic will use it as the default route.
However, this normally happens by default because this route is typically a
better match than the generic default route.

Creating policy-based VPN security policy

Define an IPsec security policy to permit communications between the source and destination addresses.

1. Go to Policy & Objects > IPv4 Policy.
2. Complete the following:

Incoming Interface Select internal.

The interface that connects to the private network behind this FortiGate
unit.
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Source Address Select Finance_networkwhen configuring FortiGate_1.

Select HR_networkwhen configuring FortiGate_2.

The address name defined for the private network behind this FortiGate
unit.

Outgoing Interface Select wan1.

The FortiGate unit’s public interface.

Destination Address Select HR_networkwhen configuring FortiGate_1.

Select Finance_networkwhen configuring FortiGate_2.

VPN Tunnel Select Use Existing and select peer_1 from the VPN Tunnel drop-down
list.

Select Allow traffic to be initiated from the remote site to enable
traffic from the remote network to initiate the tunnel.

Comments Bidirectional policy-based VPN policy.

Place VPN policies in the policy list above any other policies having similar source and destination addresses.

How to work with overlapping subnets
A site-to-site VPN configuration sometimes has the problem that the private subnet addresses at each end are
the same. You can resolve this problem by remapping the private addresses using virtual IP addresses (VIP).

VIPs allow computers on those overlapping private subnets to each have another set of IP addresses that can be
used without confusion. The FortiGate unit maps the VIP addresses to the original addresses. This means if PC1
starts a session with PC2 at 10.31.101.10, FortiGate_2 directs that session to 10.11.101.10 — the actual IP
address of PC2.The figure below demonstrates this— Finance network VIP is 10.21.101.0/24 and the HR
network is 10.31.101.0/24.
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Overlapped subnets example

Solution for route-based VPN

You need to:

l Configure IPsec Phase 1 and Phase 2 as you usually would for a route-based VPN. In this example, the resulting
IPsec interface is named FGT1_to_FGT2.

l Configure virtual IP (VIP) mapping:
l the 10.21.101.0/24 network mapped to the 10.11.101.0/24 network on FortiGate_1
l the 10.31.101.0/24 network mapped to the 10.11.101.0/24 network on FortiGate_2

l Configure an outgoing security policy with ordinary source NAT on both FortiGates.
l Configure an incoming security policy with the VIP as the destination on both FortiGates.
l Configure a route to the remote private network over the IPsec interface on both FortiGates.

To configure VIP mapping on both FortiGates

1. Go to Policy & Objects > Virtual IPs and create a new Virtual IP.
2. Enter the following information, and select OK:

Name Enter a name, for example, my_vip.

External Interface Select FGT1_to_FGT2. The IPsec interface.
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VIP Type Depending on both FortiGates, select one of the following options:

l IPv4: If both FortiGates use IPv4 (Static NAT).
l IPv6: If both FortiGates use IPv6 (Static NAT).
l NAT46: Maps the IPv4 address into an IPv6 prefix.
l NAT64: Maps the IPv6 address into an IPv4 prefix.

External IP Address/Range For the External IP Address field enter:

10.21.101.1 when configuring FortiGate_1, or
10.31.101.1 when configuring FortiGate_2.

Mapped IP Address/Range For theMapped IP Address enter 10.11.101.1.

For the Range enter 10.11.101.254.

Port Forwarding Disable

3. Repeat this procedure on both FortiGate_1 and FortiGate_2.

To configure the outbound security policy on both FortiGates

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information, and select OK:

Incoming Interface Select Port 1.

Outgoing Interface Select FGT1_to_FGT2.

The IPsec interface.

Source Select all.

Destination Address Select all.

Action Select ACCEPT

NAT Enable NAT.

3. Repeat this procedure on both FortiGate_1 and FortiGate_2.

To configure the inbound security policy on both FortiGates

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information, and then select OK:

Incoming Interface Select FGT1_to_FGT2.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2088



Gateway-to-gateway

Outgoing Interface Select Port 1.

The IPsec interface.

Source Select all.

Destination Address Selectmy-vip.

Action Select ACCEPT

NAT Disable NAT.

3. Repeat this procedure on both FortiGate_1 and FortiGate_2.

To configure the static route for both FortiGates

1. Go to Network > Static Routes and create a newRoute (or IPv6 Route as necessary).
2. Enter the following information, and then select OK:

Destination Enter a subnet of 10.31.101.0/24 when configuring FortiGate_1.

Enter a subnet of 10.21.101.0/24 when configuring FortiGate_2.

Device Select FGT1_to_FGT2.

Gateway Leave as default: 0.0.0.0.

Administrative Distance Leave at default (10).

If you have advanced routing on your network, you may have to change this
value.

Advanced Options If you have advanced routing on your network, enable Advanced Options
and enter a Priority.

Solution for policy-based VPN

As with the route-based solution, users contact hosts at the other end of the VPN using an alternate subnet
address. PC1 communicates with PC2 using IP address 10.31.101.10, and PC2 communicates with PC1 using IP
address 10.21.101.10.

In this solution however, outbound NAT is used to translate the source address of packets from the
10.11.101.0/24 network to the alternate subnet address that hosts at the other end of the VPN use to reply.
Inbound packets from the remote end have their destination addresses translated back to the 10.11.101.0/24
network.

For example, PC1 uses the destination address 10.31.101.10 to contact PC2. Outbound NAT on FortiGate_1
translates the PC1 source address to 10.21.101.10. At the FortiGate_2 end of the tunnel, the outbound NAT
configuration translates the destination address to the actual PC2 address of 10.11.101.10. Similarly, PC2 replies
to PC1 using destination address 10.21.101.10, with the PC2 source address translated to 10.31.101.10. PC1
and PC2 can communicate over the VPN even though they both have the same IP address.

You need to:
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l Configure IPsec Phase 1 as you usually would for a policy-based VPN.
l Configure IPsec Phase 2 with the use-natip disable CLI option.
l Define a firewall address for the local private network, 10.11.101.0/24.
l Define a firewall address for the remote private network:

l Define a firewall address for 10.31.101.0/24 on FortiGate_1
l Define a firewall address for 10.21.101.0/24 on FortiGate_2

l Configure an outgoing IPsec security policy with outbound NAT to map 10.11.101.0/24 source addresses:
l To the 10.21.101.0/24 network on FortiGate_1
l To the 10.31.101.0/24 network on FortiGate_2

To configure IPsec Phase 2 - CLI

config vpn ipsec phase2
edit "FGT1_FGT2_p2"

set keepalive enable
set pfs enable
set phase1name FGT1_to_FGT2
set proposal 3des-sha1 3des-md5
set replay enable
set use-natip disable

end

In this example, your Phase 1 definition is named FGT1_to_FGT2. use-natip is set to disable, so you can
specify the source selector using the src-addr-type, src-start-ip / src-end-ip or src-subnet
keywords. This example leaves these keywords at their default values, which specify the subnet 0.0.0.0/0.

The pfs keyword ensures that perfect forward secrecy (PFS) is used. This ensures that each Phase 2 key created
is unrelated to any other keys in use.

To define the local private network firewall address

1. Go to Policy & Objects > Addresses and create a newAddress.
2. Enter the following information and select OK.

Category Set to Address.

Name Enter vpn-local. A meaningful name for the local private network.

Type Set to IP/Netmask.

Subnet / IP Range 10.11.101.0 255.255.255.0

Interface Set to any.

To define the remote private network firewall address

1. Go to Policy & Objects > Addresses and create a newAddress.
2. Enter the following information, and select OK:

Category Set to Address.
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Name Enter vpn-remote. A meaningful name for the remote private network.

Type Set to IP/Netmask.

Subnet / IP Range 10.31.101.0 255.255.255.0 on FortiGate_1.

10.21.101.0 255.255.255.0 on FortiGate_2.

Interface Any

To configure the IPsec security policy

In the CLI on FortiGate_1, enter the commands:

config firewall policy
edit 1

set srcintf "port1"
set dstintf "port2"
set srcaddr "vpn-local"
set dstaddr "vpn-remote"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "FGT1_to_FGT2"
set natoutbound enable
set natip 10.31.101.0 255.255.255.0

end

Optionally, you can set everything except natip in the web-based manager and then use the CLI to set natip.

Enter the same commands on FortiGate_2, but set natip be 10.21.101.0 255.255.255.0.

Testing
The best testing is to look at the packets both as the VPN tunnel is negotiated, and when the tunnel is up.

Determining what the other end of the VPN tunnel is proposing

1. Start a terminal program such as PuTTY and set it to log all output.
When necessary refer to the logs to locate information when output is verbose.

2. Logon to the FortiGate unit using a super_admin account.
3. Enter the following CLI commands.
4. Display all the possible IKE error types and the number of times they have occurred:

diag vpn ike errors

5. Check for existing debug sessions:

diag debug info

If a debug session is running, to halt it enter:
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diag debug disable

6. Confirm your proposal settings:

diag vpn ike config list

7. If your proposal settings do not match what you expect, make a change to it and save it to force an update in
memory. If that fixes the problem, stop here.

8. List the current vpn filter:

diag vpn ike filter

9. If all fields are set to any, there are no filters set and all VPN IKE packets will be displayed in the debug output. If
your system has only a few VPNs, skip setting the filter.
If your system has many VPN connections this will result in very verbose output and make it very difficult to locate
the correct connection attempt.

10. Set the VPN filter to display only information from the destination IP address for example 10.10.10.10:

diag vpn ike log-filter dst-addr4 10.10.10.10

To add more filter options, enter them one per line as above. Other filter options are:

clear erase the current filter

dst-addr6 the IPv6 destination address range to filter by

dst-port the destination port range to filter by

interface interface that IKE connection is negotiated over

list display the current filter

name the phase1 name to filter by

negate negate the specified filter parameter

src-addr4 the IPv4 source address range to filter by

src-addr6 the IPv6 source address range to filter by

src-port the source port range to filter by

vd index of virtual domain. 0 matches all

11. Start debugging:

diag debug app ike 255
diag debug enable

12. Have the remote end attempt a VPN connection.
If the remote end attempts the connection they become the initiator. This situation makes it easier to debug VPN
tunnels because then you have the remote information and all of your local information. by initiate the connection,
you will not see the other end’s information.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2092



Gateway-to-gateway

13. If possible go to the web-based manager on your FortiGate unit, go to the VPNmonitor and try to bring the tunnel
up.

14. Stop the debug output:

diag debug disable

15. Go back through the output to determine what proposal information the initiator is using, and how it is different
from your VPN P1 proposal settings.
Things to look for in the debug output of attempted VPN connections are shown below.

Important terms to look for in VPN debug output

initiator Starts the VPN attempt, in the above procedure that is the remote end

responder Answers the initiator’s request

local ID In aggressive mode, this is not encrypted

error no SA
proposal
chosen

There was no proposal match — there was no encryption-authentication pair in
common, usually occurs after a long list of proposal attempts

R U THERE
and
R U THERE
ack

dead peer detection (dpd), also known as dead gateway detection — after three failed
attempts to contact the remote end it will be declared dead, no farther attempts will be
made to contact it

negotiation
result lists the proposal settings that were agreed on

SA_life_soft
and SA_life_
hard

negotiating a new key, and the key life

R U THERE If you see this, it means Phase 1 was successful

tunnel up the negotiation was successful, the VPN tunnel is operational

2093 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Hub-and-spoke configurations

This section describes how to set up hub-and-spoke IPsec VPNs. The following topics are included in this section:

Configuration overview
In a hub-and-spoke configuration, VPN connections radiate from a central FortiGate unit (the hub) to a number of
remote peers (the spokes). Traffic can pass between private networks behind the hub and private networks
behind the remote peers. Traffic can also pass between remote peer private networks through the hub.

Example hub-and-spoke configuration

The actual implementation varies in complexity depending on:

l Whether the spokes are statically or dynamically addressed
l The addressing scheme of the protected subnets
l How peers are authenticated
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This guide discusses the issues involved in configuring a hub-and-spoke VPN and provides some basic
configuration examples.

Hub-and-spoke infrastructure requirements

l The FortiGate hub must be operating in NAT mode and have a static public IP address.
l Spokes may have static IP addresses, dynamic IP addresses (see FortiGate dialup-client configurations on page

2133), or static domain names and dynamic IP addresses (see Dynamic DNS configuration on page 2111).

Spoke gateway addressing

The public IP address of the spoke is the VPN remote gateway as seen from the hub. Statically addressed spokes
each require a separate VPN Phase 1 configuration on the hub. When there are many spokes, this becomes
rather cumbersome.

Using dynamic addressing for spokes simplifies the VPN configuration because then the hub requires only a
single Phase 1 configuration with “dialup user” as the remote gateway. You can use this configuration even if the
remote peers have static IP addresses. A remote peer can establish a VPN connection regardless of its IP
address if its traffic selectors match and it can authenticate to the hub. See Configuration overview on page 2094
for an example of this configuration.

Protected networks addressing

The addresses of the protected networks are needed to configure destination selectors and sometimes for
security policies and static routes. The larger the number of spokes, the more addresses there are to manage.
You can

l Assign spoke subnets as part of a larger subnet, usually on a new network

or

l Create address groups that contain all of the needed addresses

Using aggregated subnets

If you are creating a new network, where subnet IP addresses are not already assigned, you can simplify the VPN
configuration by assigning spoke subnets that are part of a large subnet.
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Aggregated subnets

All spokes use the large subnet address, 10.1.0.0/16 for example, as:

l The IPsec destination selector
l The destination of the security policy from the private subnet to the VPN (required for policy-based VPN, optional for

route-based VPN)
l The destination of the static route to the VPN (route-based)

Each spoke uses the address of its own protected subnet as the IPsec source selector and as the source address
in its VPN security policy. The remote gateway is the public IP address of the hub FortiGate unit.

Using an address group

If you want to create a hub-and-spoke VPN between existing private networks, the subnet addressing usually
does not fit the aggregated subnet model discussed earlier. All of the spokes and the hub will need to include the
addresses of all the protected networks in their configuration.

On FortiGate units, you can define a named firewall address for each of the remote protected networks and add
these addresses to a firewall address group. For a policy-based VPN, you can then use this address group as the
destination of the VPN security policy.

For a route-based VPN, the destination of the VPN security policy can be set to All. You need to specify
appropriate routes for each of the remote subnets.

Authentication

Authentication is by a common pre-shared key or by certificates. For simplicity, the examples in this chapter
assume that all spokes use the same pre-shared key.

Configure the hub
At the FortiGate unit that acts as the hub, you need to:

l Configure the VPN to each spoke
l Configure communication between spokes
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You configure communication between spokes differently for a policy-based VPN than for a route-based VPN. For
a policy-based VPN, you configure a VPN concentrator. For a route-based VPN, you must either define security
policies or group the IPsec interfaces into a zone.

Define the hub-spoke VPNs

Perform these steps at the FortiGate unit that will act as the hub. Although this procedure assumes that the
spokes are all FortiGate units, a spoke could also be VPN client software, such as FortiClient Endpoint Security.

Configuring the VPN hub

1. At the hub, define the Phase 1 configuration for each spoke. See Phase 1 parameters on page 2048. Enter these
settings in particular:

Name Enter a name to identify the VPN in Phase 2 configurations, security
policies and the VPNmonitor.

Remote Gateway The remote gateway is the other end of the VPN tunnel. There are three
options:

Static IP Address— Enter the spoke’s public IP Address. You will need to
create a Phase 1 configuration for each spoke. Either the hub or the spoke
can establish the VPN connection.

Dialup User— No additional information is needed. The hub accepts
connections from peers with appropriate encryption and authentication
settings. Only one Phase 1 configuration is needed for multiple dialup
spokes. Only the spoke can establish the VPN tunnel.

Dynamic DNS— If the spoke subscribes to a dynamic DNS service, enter
the spoke’sDynamic DNS domain name. Either the hub or the spoke can
establish the VPN connection. For more information, see Dynamic DNS
configuration on page 1.

Local Interface Select the FortiGate interface that connects to the remote gateway. This is
usually the FortiGate unit’s public interface.

2. Define the Phase 2 parameters needed to create a VPN tunnel with each spoke. See Phase 2 parameters on page
2067. Enter these settings in particular:

Name Enter a name to identify this spoke Phase 2 configuration.

Phase 1 Select the name of the Phase 1 configuration that you defined for this
spoke.

IPsec VPN in ADVPN hub-and-spoke

IPsec VPN traffic is allowed through a tunnel between an ADVPN hub-and-spoke.

CLI Syntax:

config vpn ipsec phase1-interface
edit "int-fgtb"
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...
set auto-discovery-sender [enable | disable]
set auto-discovery-receiver [enable | disable]
set auto-discovery-forwarder [enable | disable]
...

next
end
config vpn ipsec phase2-interface

edit "int-fgtb"
...
set auto-discovery-sender phase1 [enable | disable]
...

next
end

Define the hub-spoke security policies

1. Define a name for the address of the private network behind the hub. For more information, see Defining policy
addresses on page 1.

2. Define names for the addresses or address ranges of the private networks behind the spokes. For more
information, see Defining policy addresses on page 1.

3. Define the VPN concentrator. See To define the VPN concentrator on page 2099.
4. Define security policies to permit communication between the hub and the spokes. For more information, see

Defining VPN security policies on page 1.

Route-based VPN security policies

Define ACCEPT security policies to permit communications between the hub and the spoke. You need one policy
for each direction.

Adding policies

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter these settings in particular:

Incoming Interface Select the VPN Tunnel (IPsec Interface) you configured in Step 1.

Source Address Select the address name you defined in Step 2 for the private network
behind the spoke FortiGate unit.

Outgoing Interface Select the hub’s interface to the internal (private) network.

Destination Address Select the source address that you defined in Step 1.

Action Select ACCEPT.

Enable NAT Enable.

Incoming Interface Select the VPN Tunnel (IPsec Interface) you configured inStep 1.
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Source Address Select the address name you defined in Step 2 for the private network
behind the spoke FortiGate units.

Outgoing Interface Select the source address that you defined in Step 1.

Destination Address Select the hub’s interface to the internal (private) network.

Action Select ACCEPT.

Enable NAT Enable.

Policy-based VPN security policy

Define an IPsec security policy to permit communications between the hub and the spoke.

Adding policies

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Incoming Interface Select the hub’s interface to the internal (private) network.

Source Address Select the source address that you defined in Step 1.

Outgoing Interface Select the hub’s public network interface.

Destination Address Select the address name you defined in Step 2 for the private network
behind the spoke FortiGate unit.

VPN Tunnel Select Use Existing and select the name of the Phase 1 configuration that
you created for the spoke in Step 1.

Select Allow traffic to be initiated from the remote site to enable
traffic from the remote network to initiate the tunnel.

In the policy list, arrange the policies in the following order:

l IPsec policies that control traffic between the hub and the spokes first
l The default security policy last

Configuring communication between spokes (policy-based VPN)

For a policy-based hub-and-spoke VPN, you define a concentrator to enable communication between the spokes.

To define the VPN concentrator

1. At the hub, go to VPN > IPsec Concentrator and select Create New.
2. In the Concentrator Name field, type a name to identify the concentrator.
3. From the Available Tunnels list, select a VPN tunnel and then select the right-pointing arrow.
4. Repeat Step 3 until all of the tunnels associated with the spokes are included in the concentrator.
5. Select OK.
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Configuring communication between spokes (route-based VPN)

For a route-based hub-and-spoke VPN, there are several ways you can enable communication between the
spokes:

l Put all of the IPsec interfaces into a zone and enable intra-zone traffic. This eliminates the need for any security
policy for the VPN, but you cannot apply UTM features to scan the traffic for security threats.

l Put all of the IPsec interfaces into a zone and create a single zone-to-zone security policy
l Create a security policy for each pair of spokes that are allowed to communicate with each other. The number of

policies required increases rapidly as the number of spokes increases.

Using a zone as a concentrator

A simple way to provide communication among all of the spokes is to create a zone and allow intra-zone
communication. You cannot apply UTM features using this method.

1. Go to Network > Interfaces.
2. Select the down-arrow on the Create New button and select Zone.
3. In the Zone Name field, enter a name, such as Our_VPN_zone.
4. ClearBlock intra-zone traffic.
5. In the Interface Members list, select the IPsec interfaces that are part of your VPN.
6. Select OK.

Using a zone with a policy as a concentrator

If you put all of the hub IPsec interfaces involved in the VPN into a zone, you can enable communication among
all of the spokes and apply UTM features with just one security policy.

Creating a zone for the VPN

1. Go to Network > Interfaces.
2. Select the down-arrow on the Create New button and select Zone.
3. In the Zone Name field, enter a name, such as Our_VPN_zone.
4. Select Block intra-zone traffic.
5. In the Interface Members list, select the IPsec interfaces that are part of your VPN.
6. Select OK.

Creating a security policy for the zone

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter the settings: and select OK.

Incoming Interface Select the zone you created for your VPN.

Source Address Select All.

Outgoing Interface Select the zone you created for your VPN.
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Destination Address Select All.

Action Select ACCEPT.

Enable NAT Enable.

Using security policies as a concentrator

To enable communication between two spokes, you need to define an ACCEPT security policy for them. To allow
either spoke to initiate communication, you must create a policy for each direction. This procedure describes a
security policy for communication from Spoke 1 to Spoke 2. Others are similar.

1. Define names for the addresses or address ranges of the private networks behind each spoke. For more
information, see Defining policy addresses on page 1.

2. Go to Policy & Objects > IPv4 Policy and select Create New.
3. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
4. Enter the settings and select OK.

Incoming Interface Select the IPsec interface that connects to Spoke 1.

Source Address Select the address of the private network behind Spoke 1.

Outgoing Interface Select the IPsec interface that connects to Spoke 2.

Destination Address Select the address of the private network behind Spoke 2.

Action Select ACCEPT.

Enable NAT Enable.

Configure the spokes
Although this procedure assumes that the spokes are all FortiGate units, a spoke could also be VPN client
software, such as FortiClient Endpoint Security.

Perform these steps at each FortiGate unit that will act as a spoke.

Creating the Phase 1 and phase_2 configurations

1. At the spoke, define the Phase 1 parameters that the spoke will use to establish a secure connection with the hub.
See Phase 1 parameters on page 2048. Enter these settings:

Remote Gateway Select Static IP Address.

IP Address Type the IP address of the interface that connects to the hub.

2. Create the Phase 2 tunnel definition. See Phase 2 parameters on page 2067. Select the set of Phase 1
parameters that you defined for the hub. You can select the name of the hub from the Static IP Address part of
the list.

2101 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Hub-and-spoke configurations

Configuring security policies for hub-to-spoke communication

1. Create an address for this spoke. See Defining policy addresses on page 1. Enter the IP address and netmask of
the private network behind the spoke.

2. Create an address to represent the hub. See Defining policy addresses on page 1. Enter the IP address and
netmask of the private network behind the hub.

3. Define the security policy to enable communication with the hub.

Route-based VPN security policy

Define two security policies to permit communications to and from the hub.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter these settings:

Incoming Interface Select the virtual IPsec interface you created.

Source Address Select the hub address you defined in Step 1.

Outgoing Interface Select the spoke’s interface to the internal (private) network.

Destination Address Select the spoke addresses you defined in Step 2.

Action Select ACCEPT.

Enable NAT Enable

Incoming Interface Select the spoke’s interface to the internal (private) network.

Source Address Select the spoke address you defined in Step 1.

Outgoing Interface Select the virtual IPsec interface you created.

Destination Address Select the hub destination addresses you defined in Step 2.

Action Select ACCEPT.

Enable NAT Enable

Policy-based VPN security policy

Define an IPsec security policy to permit communications with the hub. See Defining VPN security policies on
page 1.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Incoming Interface Select the spoke’s interface to the internal (private) network.

Source Address Select the spoke address you defined in Step 1.
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Outgoing Interface Select the spoke’s interface to the external (public) network.

Destination Address Select the hub address you defined in Step 2.

VPN Tunnel Select Use Existing and select the name of the Phase 1 configuration you
defined.

Select Allow traffic to be initiated from the remote site to enable
traffic from the remote network to initiate the tunnel.

Configuring security policies for spoke-to-spoke communication

Each spoke requires security policies to enable communication with the other spokes. Instead of creating
separate security policies for each spoke, you can create an address group that contains the addresses of the
networks behind the other spokes. The security policy then applies to all of the spokes in the group.

1. Define destination addresses to represent the networks behind each of the other spokes. Add these addresses to
an address group.

2. Define the security policy to enable communication between this spoke and the spokes in the address group you
created.

Policy-based VPN security policy

Define an IPsec security policy to permit communications with the other spokes. See Defining VPN security
policies on page 1. Enter these settings in particular:

Route-based VPN security policy

Define two security policies to permit communications to and from the other spokes.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter these settings in particular:

Incoming Interface Select the virtual IPsec interface you created.

Source Address Select the spoke address group you defined in Step "Configure the spokes "
on page 2101.

Outgoing Interface Select the spoke’s interface to the internal (private) network.

Destination Address Select this spoke’s address name.

Action Select ACCEPT.

Enable NAT Enable

4. Select Create New, leave the Policy Type as Firewall and leave the Policy Subtype asAddress, and enter
these settings:

Incoming Interface Select the spoke’s interface to the internal (private) network.

2103 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Hub-and-spoke configurations

Source Address Select this spoke’s address name.

Outgoing Interface Select the virtual IPsec interface you created.

Destination Address Select the spoke address group you defined in Step 1.

Action Select ACCEPT.

Enable NAT Enable

Policy-based VPN security policy

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following:

Incoming Interface Select this spoke’s internal (private) network interface.

Source Address Select this spoke’s source address.

Outgoing Interface Select the spoke’s interface to the external (public) network.

Destination Address Select the spoke address group you defined in Step 1.

VPN Tunnel Select Use Existing and select the name of the Phase 1 configuration you
defined.

Select Allow traffic to be initiated from the remote site to enable
traffic from the remote network to initiate the tunnel.

Place this policy or policies in the policy list above any other policies having similar source and destination
addresses.

Dynamic spokes configuration example
This example demonstrates how to set up a basic route-based hub-and-spoke IPsec VPN that uses preshared
keys to authenticate VPN peers.
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Example hub-and-spoke configuration

In the example configuration, the protected networks 10.1.0.0/24, 10.1.1.0/24 and 10.1.2.0/24 are all part of the
larger subnet 10.1.0.0/16. The steps for setting up the example hub-and-spoke configuration create a VPN
among Site 1, Site 2, and the HR Network.

The spokes are dialup. Their addresses are not part of the configuration on the hub, so only one spoke definition
is required no matter the number of spokes. For simplicity, only two spokes are shown.

In an ADVPN topology, any two pair of peers can create a shortcut, as long as one of the devices is not behind
NAT.

The on-the-wire format of the ADVPNmessages use TLV encoding. Because of this, this feature is not
compatible with any previous ADVPN builds.

Configure the hub (FortiGate_1)

The Phase 1 configuration defines the parameters that FortiGate_1 will use to authenticate spokes and establish
secure connections.

For the purposes of this example, one preshared key will be used to authenticate all of the spokes. Each key must
contain at least 6 printable characters and best practices dictates that it only be known by network administrators.
For optimum protection against currently known attacks, each key must consist of a minimum of 16 randomly
chosen alphanumeric characters.
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Define the IPsec configuration

1. At FortiGate_1, go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).

Define the Phase 1 parameters that the hub will use to establish a secure connection to the spokes.

Name Enter a name (for example, toSpokes).

Remote Gateway Dialup user

Local Interface External

Mode Main

Authentication Method Preshared Key

Pre-shared Key Enter the preshared key.

Peer Options Any peer ID

The basic Phase 2 settings associate IPsec Phase 2 parameters with the Phase 1 configuration and specify the
remote end points of the VPN tunnels.

3. Open the Phase 2 Selectors panel (if it is not available, you may need to click the Convert to Custom Tunnel
button).

4. Enter the following information, and select OK:

Name Enter a name for the Phase 2 definition (for example, toSpokes_ph2).

Phase 1 Select the Phase 1 configuration that you defined previously (for example,
toSpokes).

Define the security policies

security policies control all IP traffic passing between a source address and a destination address. For a route-
based VPN, the policies are simpler than for a policy-based VPN. Instead of an IPSEC policy, you use an
ACCEPT policy with the virtual IPsec interface as the external interface.

Before you define security policies, you must first define firewall addresses to use in those policies. You need
addresses for:

l The HR network behind FortiGate_1
l The aggregate subnet address for the protected networks

Defining the IP address of the HR network behind FortiGate_1

1. Go to Policy & Objects > Addresses.
2. Select Create New, enter the following information, and select OK:

Name Enter an address name (for example, HR_Network).
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Type Subnet

Subnet/IP Range Enter the IP address of the HR network behind FortiGate_1
(for example, 10.1.0.0/24).

Specifying the IP address the aggregate protected subnet

1. Go to Policy & Objects > Addresses.
2. Select Create New, enter the following information, and select OK:

Address Name Enter an address name (for example, Spoke_net).

Type Subnet

Subnet/IP Range Enter the IP address of the aggregate protected network, 10.1.0.0/16

Defining the security policy for traffic from the hub to the spokes

1. Go to Policy & Objects > IPv4 Policy and select Create New,
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter the following information, and select OK:

Incoming Interface Select the interface to the HR network, port 1.

Source Address Select HR_Network.

Outgoing Interface Select the virtual IPsec interface that connects to the spokes, toSpokes.

Destination Address Select Spoke_net.

Action Select ACCEPT.

Place the policy in the policy list above any other policies having similar source and destination addresses.

Configure communication between spokes

Spokes communicate with each other through the hub. You need to configure the hub to allow this
communication. An easy way to do this is to create a zone containing the virtual IPsec interfaces even if there is
only one, and create a zone-to-zone security policy.

1. Go to Network > Interfaces.
2. Select the down-arrow on the Create New button and select Zone.
3. In the Zone Name field, enter a name, such as Our_VPN_zone.
4. Select Block intra-zone traffic.

You could enable intra-zone traffic and then you would not need to create a security policy. But, you would not be
able to apply UTM features.

5. In Interface Members, select the virtual IPsec interface, toSpokes.
6. Select OK.
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Creating a security policy for the zone

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter these settings:

Incoming Interface Select Our_VPN_zone.

Source Address Select All.

Outgoing Interface Select Our_VPN_zone.

Destination Address Select All.

Action Select ACCEPT.

Enable NAT Enable.

4. Select OK.

Configure the spokes

In this example, all spokes have nearly identical configuration, requiring the following:

l Phase 1 authentication parameters to initiate a connection with the hub.
l Phase 2 tunnel creation parameters to establish a VPN tunnel with the hub.
l A source address that represents the network behind the spoke. This is the only part of the configuration that is

different for each spoke.
l A destination address that represents the aggregate protected network.
l A security policy to ena.ble communications between the spoke and the aggregate protected network

Define the IPsec configuration

At each spoke, create the following configuration.

1. At the spoke, go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).

Enter the following information:

Name Type a name, for example, toHub.

Remote Gateway Select Static IP Address.

IP Address Enter 172.16.10.1.

Local Interface Select Port2.

Mode Main

Authentication Method Preshared Key

Pre-shared Key Enter the preshared key. The value must be identical to the preshared key
that you specified previously in the FortiGate_1 configuration
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Peer Options Select Any peer ID.

1. Open the Phase 2 Selectors panel (if it is not available, you may need to click the Convert to Custom Tunnel
button).

2. Enter the following information and select OK:

Name Enter a name for the tunnel, for example, toHub_ph2.

Phase 1 Select the name of the Phase 1 configuration that you defined previously,
for example, toHub.

Advanced Select to show the followingQuick Mode Selector settings.

Source Enter the address of the protected network at this spoke.

For spoke_1, this is 10.1.1.0/24.
For spoke_2, this is 10.1.2.0/24.

Destination Enter the aggregate protected subnet address, 10.1.0.0/16.

Define the security policies

You need to define firewall addresses for the spokes and the aggregate protected network and then create a
security policy to enable communication between them.

Defining the IP address of the network behind the spoke

1. Go to Policy & Objects > Addresses.
2. Select Create New and enter the following information:

Address Name Enter an address name, for example LocalNet.

Type Subnet

Subnet/IP Range Enter the IP address of the private network behind the spoke.

For spoke_1, this is 10.1.1.0/24.
For spoke_2, this is 10.1.2.0/24.

Specifying the IP address of the aggregate protected network

1. Go to Policy & Objects > Addresses.
2. Select Create New and enter the following information:

Address Name Enter an address name, for example, Spoke_net.

Type Subnet

Subnet/IP Range Enter the IP address of the aggregate protected network, 10.1.0.0/16.
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Defining the security policy

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter the following information:

Incoming Interface Select the virtual IPsec interface, toHub.

Source Address Select the aggregate protected network address Spoke_net.

Outgoing Interface Select the interface to the internal (private) network, port1.

Destination Address Select the address for this spoke’s protected network LocalNet.

Action Select ACCEPT.

4. Select Create New.
5. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
6. Enter the following information, and select OK:

Incoming Interface Select the interface to the internal private network, port1.

Source Address Select the address for this spoke’s protected network, LocalNet.

Outgoing Interface Select the virtual IPsec interface, toHub.

Destination Address Select the aggregate protected network address, Spoke_net.

Action Select ACCEPT.

Place these policies in the policy list above any other policies having similar source and destination addresses.
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This section describes how to configure a site-to-site VPN, in which one FortiGate unit has a static IP address and
the other FortiGate unit has a domain name and a dynamic IP address.

The following topics are included in this section:

Dynamic DNS over VPN concepts
A typical computer has a static IP address and one or more DNS servers to resolve fully qualified domain names
(FQDN) into IP addresses. A domain name assigned to this computer is resolved by any DNS server having an
entry for the domain name and its static IP address. The IP address never changes or changes only rarely so the
DNS server can reliably say it has the correct address for that domain all the time.

Dynamic DNS (DDNS)

It is different when a computer has a dynamic IP address, such as an IP address assigned dynamically by a DHCP
server, and a domain name. Computers that want to contact this computer do not know what its current IP
address is. To solve this problem there are dynamic DNS (DDNS) servers. These are public servers that store a
DNS entry for your computer that includes its current IP address and associated domain name. These entries are
kept up to date by your computer sending its current IP address to the DDNS server to ensure its entry is always
up to date. When other computers want to contact your domain, their DNS gets your IP address from your DDNS
server. To use DDNS servers, you must subscribe to them and usually pay for their services.

When configuring DDNS on your FortiGate unit, go to Network > DNS and enable Enable FortiGuard DDNS.
Then select the interface with the dynamic connection, which DDNS server you have an account with, your
domain name, and account information. If your DDNS server is not on the list, there is a generic option where you
can provide your DDNS server information.

Routing

When an interface has some form of changing IP address (DDNS, PPPoE, or DHCP assigned address), routing
needs special attention. The standard static route cannot handle the changing IP address. The solution is to use
the dynamic-gateway command in the CLI. Say for example you already have four static routes, and you have a
PPPoE connection over the wan2 interface and you want to use that as your default route.

The route is configured on the dynamic address VPN peer trying to access the static address FortiGate unit.

Configuring dynamic gateway routing - CLI

config router static
edit 5

set dst 0.0.0.0 0.0.0.0
set dynamic-gateway enable
set device wan2

next
end
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DDNS over VPN

IPsec VPN expects an IP address for each end of the VPN tunnel. All configuration and communication with that
tunnel depends on the IP addresses as reference points. However, when the interface the tunnel is on has DDNS
enabled there is no set IP address. The remote end of the VPN tunnel now needs another way to reference your
end of the VPN tunnel. This is accomplished using Local ID.

A FortiGate unit that has a domain name and a dynamic IP address can initiate VPN connections anytime. The
remote peer can reply to the local FortiGate unit using the source IP address that was sent in the packet header
because it is current. Without doing a DNS lookup first, the remote peer runs the risk of the dynamic IP changing
before it attempts to connect. To avoid this, the remote peer must perform a DNS lookup for the domain name of
to be sure of the dynamic IP address before initiating the connection.

Remote Gateway

When configuring the Phase 1 entry for a VPN tunnel, the Remote Gateway determines the addressing method
the remote end of the tunnel uses as one of Static IP Address, Dialup User, or Dynamic DNS. There are different
fields for each option.

When you select the Dynamic DNS VPN type there is a related field called Dynamic DNS. The Dynamic DNS field
is asking for the FQDN of the remote end of the tunnel. It uses this information to look up the IP address of the
remote end of the tunnel through the DDNS server associated with that domain name.

Local ID (peer ID)

The Local ID or peer ID can be used to uniquely identify one end of a VPN tunnel. This enables a more secure
connection. Also if you have multiple VPN tunnels negotiating, this ensures the proper remote and local ends
connect. When you configure it on your end, it is your Local ID. When the remote end connects to you, they see it
as your peer ID.

If you are debugging a VPN connection, the Local ID is part of the VPN negotiations. You can use it to help
troubleshoot connection problems.

In circumstances where multiple remote dialup VPN tunnels exist, each tunnel must
have a peer ID set.

Configuring your Local ID

1. Go to VPN > IPsec Wizard and create the new custom tunnel or go to VPN > IPsec Tunnels and edit an
existing tunnel.

2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert To Custom Tunnel button).
3. In the Phase 1 Proposal section, enter your Local ID.
4. Select OK.
The default configuration is to accept all local IDs (peer IDs). If you have Local ID set, the remote end of the
tunnel must be configured to accept your local ID.

Accepting a specific Peer ID

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit Authentication (if it is not available, you may need to click the Convert To Custom Tunnel button).
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3. Set Mode to Aggressive.
4. For Peer Options, select This peer ID. This option becomes visible only when Aggressivemode is selected.
5. In the Peer ID field, enter the string the other end of the tunnel used for its local ID.
6. Configure the rest of the Phase 1 entry as required.
7. Select OK.

Route-based or policy-based VPN

VPN over dynamic DNS can be configured with either route-based or policy-based VPN settings. Both are valid,
but have differences in configuration. Choose the best method based on your requirements. For more
information on route-based and policy-based, see IPsec VPN overview on page 2031.

Route-based VPN configuration requires two security policies to be configured (one for each direction of traffic) to
permit traffic over the VPN virtual interface, and you must also add a static route entry for that VPN interface or
the VPN traffic will not reach its destination. See Dynamic DNS configuration on page 2111 and Dynamic DNS
configuration on page 2111.

Policy-based VPN configuration uses more complex and often more IPsec security policies, but does not require a
static route entry. It has the benefit of being able to configure multiple policies for handling multiple protocols in
different ways, such as more scanning of less secure protocols or guaranteeing a minimum bandwidth for
protocols such as VoIP. See Dynamic DNS configuration on page 2111 and Dynamic DNS configuration on page
2111.

DDNS topology
In this scenario, two branch offices each have a FortiGate unit and are connected in a gateway-to-gateway VPN
configuration. One FortiGate unit has a domain name (example.com) with a dynamic IP address. See branch_
2 in the figure below.

Whenever the branch_2 unit connects to the Internet (and possibly also at predefined intervals set by the ISP),
the ISPmay assign a different IP address to the FortiGate unit. The unit has its domain name registered with a
dynamic DNS service. The branch_2 unit checks in with the DDNS server on a regular basis, and that server
provides the DNS information for the domain name, updating the IP address from time to time. Remote peers
have to locate the branch_2 FortiGate unit through a DNS lookup each time to ensure the address they get is
current and correct.

2113 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Dynamic DNS configuration

Example dynamic DNS configuration

When a remote peer (such as the branch_1 FortiGate unit above) initiates a connection to example.com, the
local DNS server looks up and returns the IP address that matches the domain name example.com. The
remote peer uses the retrieved IP address to establish a VPN connection with the branch_2 FortiGate unit.

Assumptions

l You have administrator access to both FortiGate units.
l Both FortiGate units have interfaces named wan1 and internal. (If not, you can use the alias feature to assign these

labels as “nicknames” to other interfaces to follow this example.)
l Both FortiGate units have the most recent firmware installed, have been configured for their networks, and are

currently passing normal network traffic.
l The branch_2 FortiGate unit has its wan1 interface defined as a dynamic DNS interface with the domain name of
example.com.

l A basic gateway-to-gateway configuration is in place (see Gateway-to-gateway configurations on page 1) except
one of the FortiGate units has a static domain name and a dynamic IP address instead of a static IP address.

l The FortiGate unit with the domain name is subscribed to one of the supported dynamic DNS services. Contact one
of the services to set up an account.

Configuration overview
When a FortiGate unit receives a connection request from a remote VPN peer, it uses IPsec Phase 1 parameters
to establish a secure connection and authenticate the VPN peer. Then, if the security policy permits the
connection, the FortiGate unit establishes the tunnel using IPsec Phase 2 parameters and applies the security
policy. Key management, authentication, and security services are negotiated dynamically through the IKE
protocol.

To support these functions, the following general configuration steps must be performed:

l Configure the branch_2 FortiGate unit with the dynamic IP address. This unit uses a Local ID string instead of an IP
address to identify itself to the remote peer. See Configuring the dynamically-addressed VPN peer below, which is
made up of configuring branch_2's VPN tunnel settings and security policies.
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l Configure the fixed-address VPN peer. To initiate a VPN tunnel with the dynamically-addressed peer, this unit must
first retrieve the IP address for the domain from the dynamic DNS service. See Configuring the fixed-address
VPN peer, which is made up of configuring branch_1's VPN tunnel settings and security policies.

Configuring the dynamically-addressed VPN peer

It is assumed that this FortiGate unit (branch_2) has already had its public facing interface, for example the
wan1, configured with the proper dynamic DNS configuration.

Configuring branch_2, the dynamic address side

Define the Phase 1 parameters needed to establish a secure connection with the remote peer. See Phase 1
parameters on page 2048. During this procedure you need to choose if you will be using route-based or policy-
based VPNs.

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit Network (full configuration options are only available once you click the Convert To Custom Tunnel

button).
3. Enter the following information:

Remote Gateway Select Static IP Address.

The remote peer this FortiGate is connecting to has a static IP public
address.

If the remote interface is PPPoE do not select Retrieve default gateway
from server.

IP Address Enter 172.16.20.1, the IP address of the public interface to the remote
peer.

Interface Select the Internet-facing interfacewan1 (selected by default).

NAT Traversal Select Enable (selected by default).
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Keepalive Frequency Enter a keepalive frequency (In seconds; set to 10 by default).

Dead Peer Detection Select a dead peer detection option. On Idlewill attempt to reestablish
VPN tunnels when a connection becomes idle (the idle interval is not a
negotiated value).
Use of periodic dead peer detection incurs extra overhead. When
communicating to large numbers of IKE peers, you should consider using
On Demand. (set toOn Demand by default).

4. Edit Authentication and complete the following:

Mode Select Aggressive.

5. Edit Phase 1 Proposal and complete the following:

Local ID Enter example.com.

A character string used by the branch_2 FortiGate unit to identify itself
to the remote peer.

This value must be identical to the value in the This peer ID field of the
Phase 1 remote gateway configuration on the branch_1 remote peer. See
Configuration overview on page 2114.

6. Open the Phase 2 Selectors panel.
Define the Phase 2 parameters needed to create a VPN tunnel with the remote peer. For details on Phase 2, see
Phase 2 parameters on page 2067.

7. Enter the following information and select OK.

Name Automatically entered as the name of the VPN tunnel.

Phase 1 Select branch_2.

The name of the Phase 1 configuration that you defined earlier.

Define security policies to permit communications between the private networks through the VPN tunnel. Route-
based and policy-based VPNs require different security policies. For detailed information about creating security
policies, see Defining VPN security policies on page 1.

After defining the two address ranges, select one of Creating branch_2 route-ased security policies on page 2117
or Creating branch_2 policy-based security policies on page 2119 to configure the appropriate VPN policies.

Define VPN connection names for the address ranges of the private networks. These addresses are used in the
security policies that permit communication between the networks. For more information, see Defining VPN
security policies on page 1.

Define an address name for the IP address and netmask of the private network behind the local FortiGate unit.

1. Go to Policy & Objects > Addresses.
2. Select Create New.
3. Enter the following information, and select OK.
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Name Enter branch_2_internal. Enter a meaningful name.

Type Select IP/Netmask.

Subnet / IP Range Enter 10.10.10.0/24.

Include the netmask or specify a specific range.

Interface Select internal. The interface that will be handling the traffic from the
internal network.

Define an address name for the IP address and netmask of the private network behind the remote
peer.

4. Select Create New.
5. Enter the following information, and select OK.

Name Enter branch_1_internal. A meaningful name for the private network
at the remote end of the VPN tunnel.

Type Select IP/Netmask.

Subnet / IP Range Enter 192.168.1.0/24.

Include the netmask. Optionally you can specify a range

Interface Select any.

The interface that will be handling the remote VPN traffic on this FortiGate
unit. If you are unsure, or multiple interfaces may be handling this traffic
use any.

Creating branch_2 route-ased security policies

Define ACCEPT security policies to permit communication between the branch_2 and branch_1 private networks.
Once the route-based policy is configured a routing entry must be configured to route traffic over the VPN
interface.

Define a policy to permit the branch_2 local FortiGate unit to initiate a VPN session with the branch_1 VPN peer.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information, and select OK.

Name Enter an appropriate name for the policy.

Incoming Interface Select internal.

The interface that connects to the private network behind this FortiGate
unit.

Outgoing Interface Select branch_2. The VPN Tunnel (IPsec Interface).
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Source Select branch_2_internal.

Select the address name for the private network behind this FortiGate
unit.

Destination Address Select branch_1_internal.

The address name the private network behind the remote peer.

Action Select ACCEPT.

NAT Disable NAT.

Comments Route-based: Initiate a branch_2 to branch_1 VPN tunnel.

Define a policy to permit the branch_1 remote VPN peer to initiate VPN sessions.

3. Select Create New.
4. Enter the following information, and select OK.

Name Enter an appropriate name for the policy.

Incoming Interface Select branch_2. The VPN Tunnel (IPsec Interface).

Outgoing Interface Select internal. The interface connecting the private network behind this
FortiGate unit.

Source Select branch_1_internal. The address name for the private network
behind the remote peer.

Destination Address Select branch_2_internal. The address name for the private network
behind this FortiGate unit.

Action Select ACCEPT.

NAT Disable NAT.

Comments Route-based: Initiate a branch_1 to branch_2 internal VPN tunnel.

5. Optionally configure any other security policy settings you require such as UTM or traffic shaping for this policy.
6. Place these policies in the policy list above any other policies having similar source and destination addresses.

This will ensure VPN traffic is matched against the VPN policies before any other policies.

Creating routing entry for VPN interface - CLI

config router static
edit 5

set dst 0.0.0.0 0.0.0.0
set dynamic-dateway enable
set device wan1

next
end

This routing entry must be added in the CLI because the dynamic-gateway option is not available in the web-
based manager.
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Creating branch_2 policy-based security policies

Define an IPsec policy to permit VPN sessions between the private networks. Define an IPsec policy to permit the
VPN sessions between the local branch_2 unit and the remote branch_1 unit.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information, and select OK.

Name Enter an appropriate name for the policy.

Incoming Interface Select internal. The interface connecting the private network behind this
FortiGate unit.

Outgoing Interface Select wan1. The FortiGate unit’s public interface.

Source Select branch_2_internal. The address name for the private network
behind this local FortiGate unit.

Destination Address Select branch_1_internal. The address name for the private network
behind branch_1, the remote peer.

Action Select IPsec. Under VPN Tunnel, select branch_2 from the drop-down
list. The name of the Phase 1 tunnel. Select Allow traffic to be initiated
from the remote site.

Comments Policy-based: allows traffic in either direction to initiate the VPN tunnel.

3. Optionally configure any other security policy settings you require such as UTM or traffic shaping for this policy.
4. Place these policies in the policy list above any other policies having similar source and destination addresses.

This will ensure VPN traffic is matched against the VPN policies before any other policies.

Configuring the fixed-address VPN peer

The fixed-address VPN peer, branch_1, needs to retrieve the IP address from the dynamic DNS service to initiate
communication with the dynamically-addressed peer, branch_2. It also depends on the peer ID (local ID) to
initiate the VPN tunnel with branch_2.
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Define the Phase 1 parameters needed to establish a secure connection with the remote peer. For more
information, see Phase 1 parameters on page 2048.

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit Network (if it is not available, you may need to click the Convert to Custom Tunnel button).
3. Enter the following information and select OK.

Remote Gateway Select Dynamic DNS. The remote peer this FortiGate is connecting to
has a dynamic IP address.

Dynamic DNS Type the fully qualified domain name of the remote peer (for example,
example.com).

Interface Select wan1. The public facing interface on the fixed-address FortiGate
unit.

Mode Config Select Aggressive.

Peer Options Select This peer ID, and enter example.com. This option only appears
when the mode is set to Aggressive. The identifier of the FortiGate unit
with the dynamic address.

4. Edit Authentication, enter the following information and select OK.

Peer Options Select This peer ID, and enter example.com. This option only appears
when the authentication method is set to Signature. The identifier of the
FortiGate unit with the dynamic address.

5. Define the Phase 2 parameters needed to create a VPN tunnel with the remote peer. See Phase 2 parameters on
page 2067. Enter these settings in particular:

Name Enter branch_1_p2. A name to identify this Phase 2 configuration.
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Phase 1 Select branch_1.

The name of the Phase 1 configuration that you defined for the remote
peer. You can select the name of the remote gateway from the Dynamic
DNS part of the list.

The branch_1 FortiGate unit has a fixed IP address and will be connecting to the branch_2 FortiGate unit
that has a dynamic IP address and a domain name of example.com. Remember if you are using route-based
security policies that you must add a route for the VPN traffic.

Defining address ranges for branch_1 security policies

As with branch_2 previously, branch_1 needs address ranges defined as well. See Defining policy addresses
on page 1.

1. Go to Policy & Objects > Addresses and select Create New > Address.
2. Enter the following information, and select OK.

Name Enter branch_2_internal. A meaningful name for the private network
behind the branch_2 FortiGate unit.

Type Select IP/Netmask.

Subnet / IP Range Enter 10.10.10.0/24. Include the netmask or specify a specific range.

Interface Select internal. This is the interface on this FortiGate unit that will be
handling with this traffic.

3. Define an address name for the IP address and netmask of the private network behind the remote peer.
4. Create another address. Enter the following information, and select OK.

Name Enter branch_1_internal. A meaningful name for the private network
behind the branch_1 peer.

Type Select IP/Netmask.

Subnet / IP Range Enter 192.168.1.0/24. Include the netmask or specify a specific range.

Interface Select any. The interface on this FortiGate unit that will be handling with
this traffic. If you are unsure, or multiple interfaces may be handling this
traffic use any.

Creating branch_1 route-based security policies

Define an ACCEPT security policy to permit communications between the source and destination addresses. See
Defining VPN security policies on page 1.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information, and select OK.
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Name Enter an appropriate name for the policy.

Incoming Interface Select internal. The interface that connects to the private network behind
the branch_1 FortiGate unit.

Outgoing Interface Select branch_1. The VPN Tunnel (IPsec Interface) you configured earlier.

Source Select branch_1_internal. The address name that you defined for the
private network behind this FortiGate unit.

Destination Address Select branch_2_internal. The address name that you defined for the
private network behind the branch_2 peer.

Action Select ACCEPT.

NAT Disable NAT.

Comments Internal -> branch2

To permit the remote client to initiate communication, you need to define a security policy for
communication in that direction.

3. Select Create New.
4. Enter the following information, and select OK.

Name Enter an appropriate name for the policy.

Incoming Interface Select branch_1. The VPN Tunnel (IPsec Interface) you configured earlier.

Outgoing Interface Select internal. The interface that connects to the private network behind
this FortiGate unit.

Source Select branch_2_internal. The address name that you defined for the
private network behind the branch_2 remote peer.

Destination Address Select branch_1_internal. The address name that you defined for the
private network behind this FortiGate unit.

Action Select ACCEPT.

NAT Disable NAT.

Comments branch_2 -> Internal

Creating branch_1 policy-based security policies

A policy-based security policy allows you the flexibility to allow inbound or outbound traffic or both through this
single policy.

This policy-based IPsec VPN security policy allows both inbound and outbound traffic

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information, and select OK.
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Incoming Interface Select internal. The interface that connects to the private network behind
this FortiGate unit.

Outgoing Interface Select wan1. The FortiGate unit’s public interface.

Source Select branch_1_internal. The address name that you defined for the
private network behind this FortiGate unit.

Destination Address Select branch_2_internal. The address name that you defined for the
private network behind the remote peer.

Action Select IPsec. Under VPN Tunnel, select branch_1 from the drop-down
list. The name of the Phase 1 tunnel. Select Allow traffic to be initiated
from the remote site.

3. Place this security policy in the policy list above any other policies having similar source and destination
addresses.

Results

Once both ends are configured, you can test the VPN tunnel.

To test the VPN initiated by branch_2

1. On branch_2, go toMonitor > IPsec Monitor.
All IPsec VPN tunnels will be listed on this page, no matter if they are connected or disconnected.

2. Select the tunnel listed for branch_2, and select the status column for that entry.
The status will sayBring Up and remote port, incoming and outgoing data will all be zero. This indicates an
inactive tunnel. When you right-click and select Bring Up, the FortiGate will try to set up a VPN session over this
tunnel. If it is successful, Bring Up will change to Active, and the arrow icon will change to a green up arrow icon.

3. If this does not create a VPN tunnel with increasing values for incoming and outgoing data, you need to start
troubleshooting:

To test the VPN initiated by branch_1

1. On branch_1, go toMonitor > IPsec Monitor.
2. Select the tunnel listed for branch_1, and select the status column.

The difference between branch_2 and branch_1 at this point is that the tunnel entry for branch-1 will not have a
remote gateway IP address. It will be resolved when the VPN tunnel is started.

3. If this does not create a VPN tunnel with increasing values for incoming and outgoing data, you need to start
troubleshooting.

Some troubleshooting ideas include:

l If there was no entry for the tunnel on the monitor page, check the Auto Key (IKE) page to verify the Phase 1 and
Phase 2 entries exist.

l Check the security policy or policies, and ensure there is an outgoing policy as a minimum.
l Check that you entered a local ID in the Phase 1 configuration, and that branch_1 has the same local ID.
l Ensure the local DNS server has an up-to-date DNS entry for exmaple.com.

For more information, see Troubleshooting on page 1.
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The FortiClient Endpoint Security application is an IPsec VPN client with antivirus, antispam and firewall
capabilities. This section explains how to configure dialup VPN connections between a FortiGate unit and one or
more FortiClient Endpoint Security applications.

FortiClient users are usually mobile or remote users who need to connect to a private network behind a FortiGate
unit. For example, the users might be employees who connect to the office network while traveling or from their
homes.

For greatest ease of use, the FortiClient application can download the VPN settings from the FortiGate unit to
configure itself automatically.

The following topics are included in this section:

Configuration overview
Dialup users typically obtain dynamic IP addresses from an ISP through Dynamic Host Configuration Protocol
(DHCP) or Point-to-Point Protocol over Ethernet (PPPoE). Then, the FortiClient Endpoint Security application
initiates a connection to a FortiGate dialup server.

By default the FortiClient dialup client has the same IP address as the host PC on which it runs. If the host
connects directly to the Internet, this is a public IP address. If the host is behind a NAT device, such as a router,
the IP address is a private IP address. The NAT device must be NAT traversal (NAT-T) compatible to pass
encrypted packets (see Phase 1 parameters on page 2048). The FortiClient application also can be configured to
use a virtual IP address (VIP). For the duration of the connection, the FortiClient application and the FortiGate
unit both use the VIP address as the IP address of the FortiClient dialup client.

The FortiClient application sends its encrypted packets to the VPN remote gateway, which is usually the public
interface of the FortiGate unit. It also uses this interface to download VPN settings from the FortiGate unit. See
Automatic configuration of FortiClient dialup clients on page 2125.
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Example FortiClient dialup-client configuration

Peer identification

The FortiClient application can establish an IPsec tunnel with a FortiGate unit configured to act as a dialup
server. When the FortiGate unit acts as a dialup server, it does not identify the client using the Phase 1 remote
gateway address. The IPsec tunnel is established if authentication is successful and the IPsec security policy
associated with the tunnel permits access. If configured, the FortiGate unit could also require FortiClient
registration, that is, the remote user would be required to have FortiClient installed before connection is
completed.

Automatic configuration of FortiClient dialup clients

The FortiClient application can obtain its VPN settings from the FortiGate VPN server. FortiClient users need to
know only the FortiGate VPN server IP address and their username and password on the FortiGate unit.

The FortiGate unit listens for VPN policy requests from clients on TCP port 8900. When the dialup client
connects:

l The client initiates a Secure Sockets Layer (SSL) connection to the FortiGate unit.
l The FortiGate unit requests a user name and password from the FortiClient user. Using these credentials, it

authenticates the client and determines which VPN policy applies to the client.
l Provided that authentication is successful, the FortiGate unit downloads a VPN policy to the client over the SSL

connection. The information includes IPsec Phase 1 and Phase 2 settings, and the IP addresses of the private
networks that the client is authorized to access.

l The client uses the VPN policy settings to establish an IPsec Phase 1 connection and Phase 2 tunnel with the
FortiGate unit.

FortiClient-to-FortiGate VPN configuration steps

Configuring dialup client capability for FortiClient dialup clients involves the following general configuration steps:

1. If you will be using VIP addresses to identify dialup clients, determine which VIP addresses to use. As a
precaution, consider using VIP addresses that are not commonly used.

2. Configure the FortiGate unit to act as a dialup server. See Configuring the FortiGate unit on page 2127.

2125 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



FortiClient dialup-client configuration

3. If the dialup clients will be configured to obtain VIP addresses through DHCP over IPsec, configure the FortiGate
unit to act as a DHCP server or to relay DHCP requests to an external DHCP server.

4. Configure the dialup clients. See Configure the FortiClient Endpoint Security application on page 2132.

Using virtual IP addresses

When the FortiClient host PC is located behind a NAT device, unintended IP address overlap issues may arise
between the private networks at the two ends of the tunnel. For example, the client’s host might receive a private
IP address from a DHCP server on its network that by co-incidence is the same as a private IP address on the
network behind the FortiGate unit. A conflict will occur in the host’s routing table and the FortiClient Endpoint
Security application will be unable to send traffic through the tunnel. Configuring virtual IP (VIP) addresses for
FortiClient applications prevents this problem.

Using VIPs ensures that client IP addresses are in a predictable range. You can then define security policies that
allow access only to that source address range. If you do not use VIPs, the security policies must allow all source
addresses because you cannot predict the IP address for a remote mobile user.

The FortiClient application must not have the same IP address as any host on the private network behind the
FortiGate unit or any other connected FortiClient application. You can ensure this by reserving a range of IP
addresses on the private network for FortiClient users. Or, you can assign FortiClient VIPs from an uncommonly
used subnet such as 10.254.254.0/24 or 192.168.254.0/24.

You can reserve a VIP address for a particular client according to its device MAC address and type of connection.
The DHCP server then always assigns the reserved VIP address to the client. For more information about this
feature, see the “dhcp reserved-address” section in the “system” chapter of the FortiGate CLI Reference.

On the host computer, you can find out the VIP address that the FortiClient Endpoint
Security application is using. For example, in Windows command prompt, type
ipconfig /all

On Linux or Mac OS X, type ifconfig in a terminal window. The output will also
show the IP address that has been assigned to the host Network Interface Card (NIC).

It is best to assign VIPs using DHCP over IPsec. The FortiGate dialup server can act as a DHCP server or relay
requests to an external DHCP server. You can also configure VIPs manually on FortiClient applications, but it is
more difficult to ensure that all clients use unique addresses.

If you assign a VIP on the private network behind the FortiGate unit and enable DHCP-
IPsec (a Phase 2 advanced option), the FortiGate unit acts as a proxy on the local
private network for the FortiClient dialup client. Whenever a host on the network
behind the dialup server issues an ARP request for the device MAC address of the
FortiClient host, the FortiGate unit answers the ARP request on behalf of the
FortiClient host and forwards the associated traffic to the FortiClient host through the
tunnel. For more information, see Phase 2 parameters on page 2067.

FortiGate units fully support RFC 3456. The FortiGate DHCP over IPsec feature can be enabled to allocate VIP
addresses to FortiClient dialup clients using a FortiGate DHCP server.

The figure below shows an example of a FortiClient-to-FortiGate VPN where the FortiClient application is
assigned a VIP on an uncommonly used subnet. The diagram also shows that while the destination for the
information in the encrypted packets is the private network behind the FortiGate unit, the destination of the IPsec
packets themselves is the public interface of the FortiGate unit that acts as the end of the VPN tunnel.
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IP address assignments in a FortiClient dialup-client configuration

Assigning VIPs by RADIUS user group

If you use XAuth authentication, you can assign users the virtual IP address stored in the Framed-IP-Address field
of their record on the RADIUS server. (See RFC 2865 and RFC 2866 for more information about RADIUS fields.)
To do this:

l Set the DHCP server IP Assignment Mode to User-group defined method. This is an Advanced setting. See
Configuring a DHCP server on a FortiGate interface on page 2131.

l Create a new firewall user group and add the RADIUS server to it.
l In your Phase 1 settings, configure the FortiGate unit as an XAuth server and select from User Group the new user

group that you created. For more information, see Phase 1 parameters on page 2048.
l Configure the FortiClient application to use XAuth. See Configuration overview on page 2124.

FortiClient dialup-client infrastructure requirements

l To support policy-based VPNs, the FortiGate dialup server may operate in either NAT mode or transparent mode.
NAT mode is required if you want to create a route-based VPN.

l If the FortiClient dialup clients will be configured to obtain VIP addresses through FortiGate DHCP relay, a DHCP
server must be available on the network behind the FortiGate unit and the DHCP server must have a direct route to
the FortiGate unit.

l If the FortiGate interface to the private network is not the default gateway, the private network behind the FortiGate
unit must be configured to route IP traffic destined for dialup clients back (through an appropriate gateway) to the
FortiGate interface to the private network. As an alternative, you can configure the IPsec security policy on the
FortiGate unit to perform inbound NAT on IP packets. Inbound NAT translates the source addresses of inbound
decrypted packets into the IP address of the FortiGate interface to the local private network.

Configuring the FortiGate unit

Configuring the FortiGate unit to establish VPN connections with FortiClient Endpoint Security users involves the
following steps:
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l Configure the VPN settings
l If the dialup clients use automatic configuration, configure the FortiGate unit as a VPN policy server
l If the dialup clients obtain VIP addresses by DHCP over IPsec, configure an IPsec DHCP server or relay

The procedures in this section cover basic setup of policy-based and route-based VPNs compatible with
FortiClient Endpoint Security. A route-based VPN is simpler to configure.

The IPsec VPN Wizard greatly simplifies IPsec VPN tunnel creation for route-based
tunnels.

To configure FortiGate unit VPN settings to support FortiClient users, you need to:

l Configure the FortiGate Phase 1 VPN settings
l Configure the FortiGate Phase 2 VPN settings
l Add the security policy

On the local FortiGate unit, define the Phase 1 configuration needed to establish a secure connection with the
FortiClient peer. See Phase 1 parameters on page 2048.

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit Network (full configuration options are only available once you click the Convert To Custom Tunnel

button).
3. Enter these settings in particular:

Remote Gateway Select Dialup User.

IP Address Enter the IP address of the remote peer.

Interface Select the interface through which clients connect to the FortiGate unit.

Mode Config When enabled, further options become available:

l Client Address Range
l Subnet Mask
l Use System DNS
l DNS Server
l Enable IPv4 Split Tunnel

Authentication Method Select Pre-shared Key.

Pre-shared Key Enter the pre-shared key. This must be the same preshared key provided to
the FortiClient users.

Peer option Select Any peer ID.

4. Edit Authentication and enter the following information:

Method Select Pre-shared Key.
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Pre-shared Key Enter the pre-shared key. This must be the same preshared key provided to
the FortiClient users.

Peer Options Set Accept Types to Any peer ID.

5. Define the Phase 2 parameters needed to create a VPN tunnel with the FortiClient peer. See Phase 2 parameters
on page 2067. Enter these settings in particular:

Name Enter a name to identify this Phase 2 configuration.

Phase 1 Select the name of the Phase 1 configuration that you defined.

Advanced Select to configure the following optional setting.

DHCP-IPsec Select if you provide virtual IP addresses to clients using DHCP.

6. Define names for the addresses or address ranges of the private networks that the VPN links. These addresses
are used in the security policies that permit communication between the networks. For more information, see
Defining policy addresses on page 1.

Enter these settings in particular:
l Define an address name for the individual address or the subnet address that the dialup users access through

the VPN.
l If FortiClient users are assigned VIP addresses, define an address name for the subnet to which these VIPs

belong.

4. Define security policies to permit communication between the private networks through the VPN tunnel. Route-
based and policy-based VPNs require different security policies. For detailed information about creating security
policies, see Defining VPN security policies on page 1.

If the security policy, which grants the VPN Connection is limited to certain services, DHCPmust be included,
otherwise the client won’t be able to retrieve a lease from the FortiGate’s (IPsec) DHCP server, because the
DHCPRequest (coming out of the tunnel) will be blocked.

Route-based VPN security policies

Define an ACCEPT security policy to permit communications between the source and destination addresses.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Name Enter an appropriate name for the policy.

Incoming Interface Select the VPN Tunnel (IPsec Interface) you configured in Step
"Configuration overview" on page 2124.

Outgoing Interface Select the interface that connects to the private network behind this
FortiGate unit.

Source Select all.
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Destination Address Select all.

Action Select ACCEPT.

NAT Disable NAT.

If you want to allow hosts on the private network to initiate communications with the FortiClient users after the
tunnel is established, you need to define a security policy for communication in that direction.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Outgoing Interface Select the interface that connects to the private network behind this
FortiGate unit.

Source Select all.

Destination Address Select all.

Action Select ACCEPT.

NAT Disable NAT.

Policy-based VPN security policy

Define an IPsec security policy to permit communications between the source and destination addresses.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Outgoing Interface Select the FortiGate unit’s public interface.

Source Select the address name that you defined in Step "Configuration overview"
on page 2124 for the private network behind this FortiGate unit.

Destination Address If FortiClient users are assigned VIPs, select the address name that you
defined for the VIP subnet. Otherwise, select all.

Action Select IPsec. Under VPN Tunnel, select the name of the Phase 1
configuration that you created in Step "Configuration overview" on page
2124 from the drop-down list. Select Allow traffic to be initiated from
the remote site.

Place VPN policies in the policy list above any other policies having similar source and destination addresses.
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Configuring the FortiGate unit as a VPN policy server

When a FortiClient application set to automatic configuration connects to the FortiGate unit, the FortiGate unit
requests a user name and password. If the user supplies valid credentials, the FortiGate unit downloads the VPN
settings to the FortiClient application.

You must do the following to configure the FortiGate unit to work as a VPN policy server for FortiClient automatic
configuration:

1. Create user accounts for FortiClient users.
2. Create a user group for FortiClient users and the user accounts that you created in step 1.
3. Connect to the FortiGate unit CLI and configure VPN policy distribution as follows:

config vpn ipsec forticlient
edit <policy_name>

set phase2name <tunnel_name>
set usergroupname <group_name>
set status enable

end

<tunnel_name> must be the Name you specified in the step 2 of Configuring the FortiGate unit on page
2127. <group_name> must be the name of the user group your created for FortiClient users.

Configuring DHCP services on a FortiGate interface

If the FortiClient dialup clients are configured to obtain a VIP address using DHCP, configure the FortiGate dialup
server to either:

l Relay DHCP requests to a DHCP server behind the FortiGate unit (see Configuring DHCP relay on a FortiGate
interface on page 2131 below).

l Act as a DHCP server (see Configuring a DHCP server on a FortiGate interface on page 2131).

Note that DHCP services are typically configured during the interface creation stage, but you can return to an
interface to modify DHCP settings if need be.

Configuring DHCP relay on a FortiGate interface

1. Go to Network > Interfaces and select the interface that you want to relay DHCP.
2. Enable DHCP Server, and create a new DHCPAddress Range and Netmask.
3. Open the Advanced... menu and set Mode to Relay.
4. Enter the DHCP Server IP.
5. Select OK.

Configuring a DHCP server on a FortiGate interface

1. Go to Network > Interfaces and select the interface that you want to act as a DHCP server.
2. Enable DHCP Server, and create a new DHCPAddress Range and Netmask.
3. Set Default Gateway to Specify, and enter the IP address of the default gateway that the DHCP server assigns

to DHCP clients.
4. Set DNS Server to Same as System DNS. If you want to use a different DNS server for VPN clients, select

Specify and enter an IP address in the available field.
5. Open the Advanced... menu and set Mode to Server.
6. Select OK.
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Configure the FortiClient Endpoint Security application

The following procedure explains how to configure the FortiClient Endpoint Security application to communicate
with a remote FortiGate dialup server using the VIP address that you specify manually. These procedures are
based on FortiClient 5.4.1.

Configuring FortiClient

This procedure explains how to configure the FortiClient application manually using the default IKE and IPsec
settings. For more information, refer to the FortiClient Administration Guide.

1. Go to Remote Access and select the Settings icon.
2. Select Add a new connection, set the new VPN connection to IPsec VPN, and complete following information:

Connection Name Enter a descriptive name for the connection.

Remote Gateway Enter the IP address or the fully qualified domain name (FQDN) of the
remote gateway.

Authentication Method Select Pre-shared Key and enter the pre-shared key in the field provided.

Authentication (XAuth) Extended Authentication (XAuth) increases security by requiring additional
user authentication in a separate exchange at the end of the VPN Phase 1
negotiation. The FortiGate unit challenges the user for a user name and
password. It then forwards the user’s credentials to an external RADIUS or
LDAP server for verification.

Implementation of XAuth requires configuration at both the FortiGate unit
and the FortiClient application.

3. Select OK.

Adding XAuth authentication

For information about configuring a FortiGate unit as an XAuth server, see Phase 1 parameters on page 2048.
The following procedure explains how to configure the FortiClient application.

Note that XAuth is not compatible with IKE version 2.
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This section explains how to set up a FortiGate dialup-client IPsec VPN. In a FortiGate dialup-client
configuration, a FortiGate unit with a static IP address acts as a dialup server and a FortiGate unit having a
dynamic IP address initiates a VPN tunnel with the FortiGate dialup server.

The following topics are included in this section:

Configuration overview
A dialup client can be a FortiGate unit. The FortiGate dialup client typically obtains a dynamic IP address from an
ISP through the Dynamic Host Configuration Protocol (DHCP) or Point-to-Point Protocol over Ethernet (PPPoE)
before initiating a connection to a FortiGate dialup server.

Example FortiGate dialup-client configuration

In a dialup-client configuration, the FortiGate dialup server does not rely on a Phase 1 remote gateway address to
establish an IPsec VPN connection with dialup clients. As long as authentication is successful and the IPsec
security policy associated with the tunnel permits access, the tunnel is established.

Several different ways to authenticate dialup clients and restrict access to private networks based on client
credentials are available. To authenticate FortiGate dialup clients and help to distinguish them from FortiClient
dialup clients when multiple clients will be connecting to the VPN through the same tunnel, best practices dictate
that you assign a unique identifier (local ID or peer ID) to each FortiGate dialup client. For more information, see
Phase 1 parameters on page 2048.
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Whenever you add a unique identifier (local ID) to a FortiGate dialup client for
identification purposes, you must select Aggressive mode on the FortiGate dialup
server and also specify the identifier as a peer ID on the FortiGate dialup server. For
more information, see Phase 1 parameters on page 2048.

Users behind the FortiGate dialup server cannot initiate the tunnel because the FortiGate dialup client does not
have a static IP address. After the tunnel is initiated by users behind the FortiGate dialup client, traffic from the
private network behind the FortiGate dialup server can be sent to the private network behind the FortiGate dialup
client.

Encrypted packets from the FortiGate dialup client are addressed to the public interface of the dialup server.
Encrypted packets from the dialup server are addressed either to the public IP address of the FortiGate dialup
client (if the dialup client connects to the Internet directly), or if the FortiGate dialup client is behind a NAT device,
encrypted packets from the dialup server are addressed to the public IP address of the NAT device.

If a router with NAT capabilities is in front of the FortiGate dialup client, the router must be NAT-T compatible for
encrypted traffic to pass through the NAT device. For more information, see Phase 1 parameters on page 2048.

When the FortiGate dialup server decrypts a packet from the FortiGate dialup client, the source address in the IP
header may be one of the following values, depending on the configuration of the network at the far end of the
tunnel:

l If the FortiGate dialup client connects to the Internet directly, the source address will be the private IP address of a
host or server on the network behind the FortiGate dialup client.

l If the FortiGate dialup client is behind a NAT device, the source address will be the public IP address of the NAT
device.

In some cases, computers on the private network behind the FortiGate dialup client may (by co-incidence) have
IP addresses that are already used by computers on the network behind the FortiGate dialup server. In this type
of situation (ambiguous routing), conflicts may occur in one or both of the FortiGate routing tables and traffic
destined for the remote network through the tunnel may not be sent.

In many cases, computers on the private network behind the FortiGate dialup client will most likely obtain IP
addresses from a local DHCP server behind the FortiGate dialup client. However, unless the local and remote
networks use different private network address spaces, unintended ambiguous routing and IP-address overlap
issues may arise.

To avoid these issues, you can configure FortiGate DHCP relay on the dialup client instead of using a DHCP
server on the network behind the dialup client. The FortiGate dialup client can be configured to relay DHCP
requests from the local private network to a DHCP server that resides on the network behind the FortiGate dialup
server. You configure the FortiGate dialup client to pass traffic from the local private network to the remote
network by enabling FortiGate DHCP relay on the FortiGate dialup client interface that is connected to the local
private network.

Afterward, when a computer on the network behind the dialup client broadcasts a DHCP request, the dialup client
relays the message through the tunnel to the remote DHCP server. The remote DHCP server responds with a
private IP address for the computer. To avoid ambiguous routing and network overlap issues, the IP addresses
assigned to computers behind the dialup client cannot match the network address space used by the private
network behind the FortiGate dialup server.
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Preventing network overlap in a FortiGate dialup-client configuration

When the DHCP server resides on the private network behind the FortiGate dialup server, the IP destination
address specified in the IPsec security policy on the FortiGate dialup client must refer to that network.

You must add a static route to the DHCP server FortiGate unit if it is not directly
connected to the private network behind the FortiGate dialup server; its IP address
does not match the IP address of the private network. Also, the destination address in
the IPsec security policy on the FortiGate dialup client must refer to the DHCP server
address. The DHCP server must be configured to assign a range of IP addresses
different from the DHCP server's local network, and also different from the private
network addresses behind the FortiGate dialup server. See Routing on page 1.

FortiGate dialup-client infrastructure requirements

The requirements are:

l The FortiGate dialup server must have a static public IP address.
l NAT mode is required if you want to create a route-based VPN.
l The FortiGate dialup server may operate in either NAT mode or transparent mode to support a policy-based VPN.
l Computers on the private network behind the FortiGate dialup client can obtain IP addresses either from a DHCP

server behind the FortiGate dialup client, or a DHCP server behind the FortiGate dialup server.
l If the DHCP server resides on the network behind the dialup client, the DHCP server must be configured to

assign IP addresses that do not match the private network behind the FortiGate dialup server.
l If the DHCP server resides on the network behind the FortiGate dialup server, the DHCP server must be

configured to assign IP addresses that do not match the private network behind the FortiGate dialup client.

Configuring the server to accept FortiGate dialup-client connections

The procedures in this section assume that computers on the private network behind the FortiGate dialup client
obtain IP addresses from a local DHCP server. The assigned IP addresses do not match the private network
behind the FortiGate dialup server.
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In situations where IP-address overlap between the local and remote private networks
is likely to occur, FortiGate DHCP relay can be configured on the FortiGate dialup
client to relay DHCP requests to a DHCP server behind the FortiGate dialup server.
For more information, see To configure DHCP relay on a FortiGate interface on page
1.

Configuring dialup client capability for FortiGate dialup clients involves the following general configuration steps:

l Determine which IP addresses to assign to the private network behind the FortiGate dialup client, and add the IP
addresses to the DHCP server behind the FortiGate dialup client. Refer to the software supplier’s documentation to
configure the DHCP server.

l Configure the FortiGate dialup server. See Configuration overview on page 2133.
l Configure the FortiGate dialup client. See Configuration overview on page 2133.

Before you begin, optionally reserve a unique identifier (peer ID) for the FortiGate dialup client. The dialup client
will supply this value to the FortiGate dialup server for authentication purposes during the IPsec Phase 1
exchange. In addition, the value will enable you to distinguish FortiGate dialup-client connections from
FortiClient dialup-client connections. The same value must be specified on the dialup server and on the dialup
client.

In circumstances where multiple remote dialup VPN tunnels exist, each tunnel must
have a peer ID set.

At the FortiGate dialup server, define the Phase 1 parameters needed to authenticate the FortiGate dialup client
and establish a secure connection. See Phase 1 parameters on page 2048.

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit Network (full configuration options are only available once you click the Convert To Custom Tunnel

button).
3. Enter these settings in particular:

Remote Gateway Select Dialup User.

Interface Select the interface through which clients connect to the FortiGate unit.

4. Edit Authentication and enter the following information:

Mode If you will be assigning an ID to the FortiGate dialup client, select
Aggressive.

Peer Options If you will be assigning an ID to the FortiGate dialup client, set Accept
Types to This peer ID and type the identifier that you reserved for the
FortiGate dialup client into the adjacent field.

5. Define the Phase 2 parameters needed to create a VPN tunnel with the FortiGate dialup client. See Phase 2
parameters on page 2067. Enter these settings in particular:

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2136



FortiGate dialup-client configurations

Name Enter a name to identify this Phase 2 configuration.

Phase 1 Select the name of the Phase 1 configuration that you defined.

6. Define names for the addresses or address ranges of the private networks that the VPN links. See Defining policy
addresses on page 1. Enter these settings in particular:
l Define an address name for the server, host, or network behind the FortiGate dialup server.
l Define an address name for the private network behind the FortiGate dialup client.

4. Define the security policies to permit communications between the private networks through the VPN tunnel.
Route-based and policy-based VPNs require different security policies. For detailed information about creating
security policies, see Defining VPN security policies on page 1.

Route-based VPN security policy

Define an ACCEPT security policy to permit communications between hosts on the private network behind the
FortiGate dialup client and the private network behind this FortiGate dialup server. Because communication
cannot be initiated in the opposite direction, there is only one policy.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Name Enter an appropriate name for the policy.

Incoming Interface Select the VPN tunnel (IPsec interface) created in Step 1.

Outgoing Interface Select the interface that connects to the private network behind this
FortiGate unit.

Source Select all.

Destination Address Select all.

Action Select ACCEPT.

NAT Disable NAT.

Policy-based VPN security policy

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Name Enter an appropriate name for the policy.

Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Outgoing Interface Select the FortiGate unit’s public interface.

Source Select the address name that you defined for the private network behind
this FortiGate unit.
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Destination Address Select the address name that you defined.

Action Select IPsec. Under VPN Tunnel, select the name of the Phase 1
configuration that you created in Step "Configuration overview " on page
2133 from the drop-down list. Select Allow traffic to be initiated from
the remote site.

3. To prevent traffic from the local network from initiating the tunnel after the tunnel has been established, you need
to disable the outbound VPN traffic in the CLI

config firewall policy
edit <policy_number>

set outbound disable
end

Place the policy in the policy list above any other policies having similar source and destination addresses.

If configuring a route-based policy, configure a default route for VPN traffic on this interface.

Configuring the FortiGate dialup client

At the FortiGate dialup client, define the Phase 1 parameters needed to authenticate the dialup server and
establish a secure connection. See Phase 1 parameters on page 2048.

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit Network (full configuration options are only available once you click the Convert To Custom Tunnel

button).
3. Enter these settings in particular:

Remote Gateway Select Static IP Address.

IP Address Type the IP address of the dialup server’s public interface.

Interface Select the interface that connects to the public network.

Mode The FortiGate dialup client has a dynamic IP address, select Aggressive.

Advanced Select to view the following options.

Local ID If you defined a peer ID for the dialup client in the FortiGate dialup server
configuration, enter the identifier of the dialup client. The value must be
identical to the peer ID that you specified previously in the FortiGate dialup
server configuration.

4. Edit Authentication and enter the following information:

Mode The FortiGate dialup client has a dynamic IP address, select Aggressive.

5. Edit Phase 1 Proposal and enter the following information:
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Local ID If you defined a peer ID for the dialup client in the FortiGate dialup server
configuration, enter the identifier of the dialup client. The value must be
identical to the peer ID that you specified previously in the FortiGate dialup
server configuration.

6. Define the Phase 2 parameters needed to create a VPN tunnel with the dialup server. See Phase 2 parameters on
page 2067. Enter these settings in particular:

Name Enter a name to identify this Phase 2 configuration.

Phase 1 Select the name of the Phase 1 configuration that you defined.

7. Define names for the addresses or address ranges of the private networks that the VPN links. See Defining policy
addresses on page 1. Enter these settings in particular:
l Define an address name for the server, host, or network behind the FortiGate dialup server.
l Define an address name for the private network behind the FortiGate dialup client.

4. Define security policies to permit communication between the private networks through the VPN tunnel. Route-
based and policy-based VPNs require different security policies. For detailed information about creating security
policies, see Defining VPN security policies on page 1.

Route-based VPN security policy

Define an ACCEPT security policy to permit communications between hosts on the private network behind this
FortiGate dialup client and the private network behind the FortiGate dialup server. Because communication
cannot be initiated in the opposite direction, there is only one policy.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:

Name Enter an appropriate name for the policy.

Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Outgoing Interface Select the VPN tunnel (IPsec interface) created in Step 1.

Source Select all.

Destination Address Select all.

Action Select ACCEPT.

NAT Disable NAT.

Policy-based VPN security policy

Define an IPsec security policy to permit communications between the source and destination addresses.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter these settings in particular:
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Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Outgoing Interface Select the FortiGate unit’s public interface.

Source Select the address name that you defined for the private network behind
this FortiGate unit.

Destination Address Select the address name that you defined for the private network behind
the dialup server.

Action Select IPsec. Under VPN Tunnel, select the name of the Phase 1
configuration that you created in Step "Configuration overview " on page
2133 from the drop-down list.
ClearAllow traffic to be initiated from the remote site to prevent
traffic from the remote network from initiating the tunnel after the tunnel
has been established.

Place the policy in the policy list above any other policies having similar source and destination addresses.

IPsec dial-up interface sharing

It is possible to use a single interface for all instances that spawn via a given phase1. In this case, instead of
creating an interface per instance, all traffic will run over the single interface and any routes that need creating will
be created on that single interface.

The CLI option "net-device[enable|disable]" is available in the phase1-interface command sets. Under
the new single-interface scheme, instead of relying on routing to guide traffic to the specific instance, all traffic
will flow to the specific device and IPsec will need to take care of locating the correct instance for outbound traffic.
For this purpose, the CLI option "tunnel-search" is provided. The option is only available when the above "net-
device" option is "disable".

There are two options for "tunnel-search", corresponding to the two ways to select the tunnel for outbound traffic.
One is "selectors", meaning selecting a peer using the IPsec selectors (proxy-ids). The other is "nexthop" where all
the peers use the same default selectors (0/0) while using some routing protocols such as BGP, OSPF, RIPng,
etc to resolve the routing. The default for "tunnel-search" is "selectors".

Syntax

config vpn ipsec phase1-interface
edit xxx

set net-device [enable|disable] Enable to create a kernel device for every dialup instance
next

end
config vpn ipsec phase1-interface

edit xxx
set net-device disable
set tunnel-search [selectors|nexthop] Search for tunnel in selectors or using nexthops

next
end
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IKEMode Config is an alternative to DHCP over IPsec. A FortiGate unit can be configured as either an IKEMode
Config server or client. This chapter contains the following sections:

IKE Mode Config overview
Dialup VPN clients connect to a FortiGate unit that acts as a VPN server, providing the client the necessary
configuration information to establish a VPN tunnel. The configuration information typically includes a virtual IP
address, netmask, and DNS server address.

IKEMode Config is available only for VPNs that are route-based, also known as interface-based. A FortiGate unit
can function as either an IKE Configuration Method server or client. IKEMode Config is configurable only in the
CLI.

Automatic configuration overview
VPN configuration for remote clients is simpler if it is automated. Several protocols support automatic
configuration:

l The Fortinet FortiClient Endpoint Security application can completely configure a VPN connection with a suitably
configured FortiGate unit given only the FortiGate unit’s address. This protocol is exclusive to Fortinet. For more
information, see FortiClient dialup-client configurations on page 1.

l DHCP over IPsec can assign an IP address, Domain, DNS and WINS addresses. The user must first configure
IPsec parameters such as gateway address, encryption and authentication algorithms.

l IKEMode Config can configure host IP address, Domain, DNS and WINS addresses. The user must first configure
IPsec parameters such as gateway address, encryption and authentication algorithms. Several network equipment
vendors support IKEMode Config, which is described in the ISAKMPConfiguration Method document draft-dukes-
ike-mode-cfg-02.txt.

This chapter describes how to configure a FortiGate unit as either an IKEMode Config server or client.

IKE Mode Config method
IKEMode Config is configured with the CLI command config vpn ipsec phase1-interface. The
mode-cfg variable enables IKEMode Config. The type field determines whether you are creating an IKE
Mode Config server or a client. Setting type to dynamic creates a server configuration, otherwise the
configuration is a client.

Creating an IKE Mode Config client

If the FortiGate unit will connect as a dialup client to a remote gateway that supports IKEMode Config, the
relevant vpn ipsec phase1-interface variables are as follows:
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Variable Description

ike-version 1 IKE v1 is the default for FortiGate IPsec VPNs.

IKEMode Config is also compatible with IKE v2
(RFC 4306). Use syntax ike-version 2.

mode-cfg enable Enable IKEMode Config.

type {ddns | static} If you set type to dynamic, an IKEMode Config server is created.

assign-ip {enable |
disable} Enable to request an IP address from the server.

interface <interface_
name>

This is a regular IPsec VPN field. Specify the physical, aggregate, or VLAN
interface to which the IPsec tunnel will be bound.

proposal <encryption_
combination>

This is a regular IPsec VPN field that determines the encryption and
authentication settings that the client will accept. For more information,
see Phase 1 parameters on page 2048.

ip-version <4 | 6> This is a regular IPsec VPN field. By default, IPsec VPNs use IPv4
addressing. You can set ip-version to 6 to create a VPN with IPv6
addressing.

IKE Mode Config client example - CLI

In this example, the FortiGate unit connects to a VPN gateway with a static IP address that can be reached
through Port 1. Only the port, gateway and proposal information needs to be configured. All other configuration
information will come from the IKEMode Config server.

config vpn ipsec phase1-interface
edit vpn1

set ip-version 4
set type static
set remote-gw <gw_address>
set interface port 1
set proposal 3des-sha1 aes128-sha1
set mode-cfg enable
set assign-ip enable

end

Creating an IKE Mode Config server

If the FortiGate unit will accept connection requests from dialup clients that support IKEMode Config, the
following vpn ipsec phase1-interface settings are required before any other configuration is
attempted:
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Variable Description

ike-version 1 IKE v1 is the default for FortiGate IPsec VPNs.

IKEMode Config is also compatible with IKE v2
(RFC 4306). Use syntax ike-version 2.

mode-cfg enable Enable IKEMode Config.

type dynamic Any other setting creates an IKEMode Config client.

interface <interface_
name>

This is a regular IPsec VPN field. Specify the physical, aggregate, or VLAN
interface to which the IPsec tunnel will be bound.

proposal <encryption_
combination>

This is a regular IPsec VPN field that determines the encryption and
authentication settings that the server will accept. For more information,
see Phase 1 parameters on page 2048.

ip-version <4 | 6> This is a regular IPsec VPN field. By default, IPsec VPNs use IPv4
addressing. You can set ip-version to 6 to create a VPN with IPv6
addressing.

IKE Mode Config server example - CLI

In this example, the FortiGate unit assigns IKEMode Config clients addresses in the range of 10.11.101.160
through 10.11.101.180. DNS and WINS server addresses are also provided. The public interface of the FortiGate
unit is Port 1.

When IKEMode-Configuration is enabled, multiple server IPs can be defined in IPsec Phase 1.

The ipv4-split-include variable specifies a firewall address that represents the networks to which the
clients will have access. This destination IP address information is sent to the clients.

Only the CLI fields required for IKEMode Config are shown here. For detailed information about these variables,
see the FortiGate CLI Reference.

config vpn ipsec phase1-interface
edit "vpn-p1"

set type dynamic
set interface "wan1"
set xauthtype auto
set mode aggressive
set mode-cfg enable
set proposal 3des-sha1 aes128-sha1
set dpd disable
set dhgrp 2
set xauthexpire on-rekey
set authusrgrp "FG-Group1"
set ipv4-start-ip 10.10.10.10
set ipv4-end-ip 10.10.10.20
set ipv4-dns-server1 1.1.1.1
set ipv4-dns-server2 2.2.2.2
set ipv4-dns-server3 3.3.3.3
set ipv4-wins-server1 4.4.4.4
set ipv4-wins-server2 5.5.5.5
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set domain "fgt1c-domain"
set banner "fgt111C-banner"
set backup-gateway "100.100.100.1" "host1.com" "host2"
set ipv4-split-include OfficeLAN

end

IP address assignment

After you have enabled the basic configuration, you can configure IP address assignment for clients, as well as
DNS and WINS server assignment. Usually you will want to assign IP addresses to clients.

The simplest method to assign IP addresses to clients is to assign addresses from a specific range, similar to a
DHCP server.

If your clients are authenticated by a RADIUS server, you can obtain the user’s IP address assignment from the
Framed-IP-Address attribute. The user must be authenticated using XAuth.

IKEMode Config can also use a remote DHCP server to assign the client IP addresses. Up to eight addresses can
be selected for either IPv4 or IPv6. After the DHCP proxy has been configured, the assign-ip-from command
is used to assign IP addresses via DHCP.

Assigning IP addresses from an address range - CLI

If your VPN uses IPv4 addresses,

config vpn ipsec phase1-interface
edit vpn1

set mode-cfg-ipversion 4
set assign-ip enable
set assign-ip-type ip
set assign-ip-from range
set ipv4-start-ip <range_start>
set ipv4-end-ip <range_end>
set ipv4-netmask <netmask>

end

If your VPN uses IPv6 addresses,

config vpn ipsec phase1-interface
edit vpn1

set mode-cfg-ipversion 6
set assign-ip enable
set assign-ip-type ip
set assign-ip-from range
set ipv6-start-ip <range_start>
set ipv6-end-ip <range_end>

end

Assigning IP addresses from a RADIUS server - CLI

The users must be authenticated by a RADIUS server and assigned to the FortiGate user group <grpname>.
Since the IP address will not be static, type is set to dynamic, and mode-cfg is enabled. This is IKE
Configuration Method so that compatible clients can configure themselves with settings that the FortiGate unit
provides.

config vpn ipsec phase1-interface
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edit vpn1
set type dynamic

set mode-cfg enable
set assign-ip enable
set assign-ip-from usrgrp
set xauthtype auto
set authusrgrp <grpname>

end

Assigning IP address from DHCP - CLI

The DHCP proxy must first be enabled for IKEMode Config to use DHCP to assign the VPN client IP address(es).

config system settings
set dhcp-proxy enable
set dhcp-server-ip [ipv4 address]
set dhcp6-server-ip [ipv6-address]

(Up to eight server addresses can be configured)

end

config vpn ipsec phase1-interface
edit vpn1

set mode-cfg enable
set assign-ip-from dhcp

next
end

Assigning IP address from a named firewall address/group - CLI

config vpn ipsec phase1-interface
edit <name>vpn1

set type dynamic
set assign-ip-from name
set ipv4-name <name>
set ipv6-name <name>

next
end

Certificate groups

IKE certificate groups consisting of up to four RSA certificates can be used in IKE Phase 1. Since CA and local
certificates are global, the IKE daemon loads them once for all VDOMs and indexes them into trees based on
subject and public key hash (for CA certificates), or certificate name (for local certicates). Certifcates are linked
together based on the issuer, and certificate chains are built by traversing these links. This reduces the need to
keep multiple copies of certificates that could exist in multiple chains.

IKE certificate groups can be configured through the CLI.

Configuring the IKE local ID - CLI

config vpn certificate local
edit <name>

set ike-localid <string>
set ike-localid-type {asnldn | fqdn}

end
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This section explains how to support secure web browsing performed by dialup VPN clients, and/or hosts behind a
remote VPN peer. Remote users can access the private network behind the local FortiGate unit and browse the
Internet securely. All traffic generated remotely is subject to the security policy that controls traffic on the private
network behind the local FortiGate unit.

The following topics are included in this section:

Configuration overview
A VPN provides secure access to a private network behind the FortiGate unit. You can also enable VPN clients to
access the Internet securely. The FortiGate unit inspects and processes all traffic between the VPN clients and
hosts on the Internet according to the Internet browsing policy. This is accomplished even though the same
FortiGate interface is used for both encrypted VPN client traffic and unencrypted Internet traffic.

In the figure below, FortiGate_1 enables secure Internet browsing for FortiClient Endpoint Security users such as
Dialup_1 and users on the Site_2 network behind FortiGate_2, which could be a VPN peer or a dialup client.

Example Internet-browsing configuration

You can adapt any of the following configurations to provide secure Internet browsing:
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l A gateway-to-gateway configuration (see Gateway-to-gateway configurations on page 1)
l A FortiClient dialup-client configuration (see FortiClient dialup-client configurations on page 1)
l A FortiGate dialup-client configuration (see FortiGate dialup-client configurations on page 1)

The procedures in this section assume that one of these configurations is in place, and that it is operating
properly.

To create an internet-browsing configuration based on an existing gateway-to-gateway configuration, you must
edit the gateway-to-gateway configuration as follows:

l On the FortiGate unit that will provide Internet access, create an Internet browsing security policy. See
Configuration overview on page 2146, below.

l Configure the remote peer or client to route all traffic through the VPN tunnel. You can do this on a FortiGate unit or
on a FortiClient Endpoint Security application. See Configuration overview on page 2146.

Creating an Internet browsing security policy

On the FortiGate unit that acts as a VPN server and will provide secure access to the Internet, you must create an
Internet browsing security policy. This policy differs depending on whether your gateway-to-gateway configuration
is policy-based or route-based.

Creating an Internet browsing policy - policy-based VPN

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and then select OK:

Name Enter an appropriate name for the policy.

Incoming Interface The interface to which the VPN tunnel is bound.

Outgoing Interface The interface to which the VPN tunnel is bound.

Source The internal range address of the remote spoke site.

Destination Address all

Action Select IPsec. Under VPN Tunnel, select the tunnel that provides access
to the private network behind the FortiGate unit. Select Allow traffic to
be initiated from the remote site.

NAT Enable NAT.

Creating an Internet browsing policy - route-based VPN

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and then select OK:

Name Enter an appropriate name for the policy.

Incoming Interface The IPsec VPN interface.
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Outgoing Interface The interface that connects to the Internet. The virtual IPsec interface is
configured on this physical interface.

Source The internal range address of the remote spoke site.

Destination Address all

Action ACCEPT

NAT Enable NAT.

The VPN clients must be configured to route all Internet traffic through the VPN tunnel.

Routing all remote traffic through the VPN tunnel
To make use of the Internet browsing configuration on the VPN server, the VPN peer or client must route all traffic
through the VPN tunnel. Usually, only the traffic destined for the private network behind the FortiGate VPN server
is sent through the tunnel.

The remote end of the VPN can be a FortiGate unit that acts as a peer in a gateway-to-gateway configuration, or
a FortiClient application that protects an individual client PC.

l To configure a remote peer FortiGate unit for Internet browsing via VPN, see Configuring a FortiGate remote peer
to support Internet browsing on page 2148.

l To configure a FortiClient Endpoint Security application for Internet browsing via VPN, see Configuring a FortiClient
application to support Internet browsing on page 2149.

These procedures assume that your VPN connection to the protected private network is working and that you
have configured the FortiGate VPN server for Internet browsing as described in Configuration overview on page
2146.

Configuring a FortiGate remote peer to support Internet browsing

The configuration changes to send all traffic through the VPN differ for policy-based and route-based VPNs.

Routing all traffic through a policy-based VPN

1. At the FortiGate dialup client, go to Policy & Objects > IPv4 Policy.
2. Select the IPsec security policy and then select Edit.
3. From the Destination Address list, select all.
4. Select OK.
Packets are routed through the VPN tunnel, not just those destined for the protected private network.

Routing all traffic through a route-based VPN

1. At the FortiGate dialup client, go to Network > Static Routes.
2. Select the default route (destination IP 0.0.0.0) and then select Edit. If there is no default route, select Create

New. Enter the following information and select OK:

Destination IP/Mask Set to Subnet and enter 0.0.0.0/0.0.0.0 in the field provided.
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Device Select the IPsec virtual interface.

Administrative Distance Leave at default.

All packets are routed through the VPN tunnel, not just packets destined for the protected private network.

Configuring a FortiClient application to support Internet browsing

By default, the FortiClient application configures the PC so that traffic destined for the remote protected network
passes through the VPN tunnel but all other traffic is sent to the default gateway. You need to modify the
FortiClient settings so that it configures the PC to route all outbound traffic through the VPN.

Routing all traffic through VPN - FortiClient application

1. At the remote host, start FortiClient.
2. Go to Remote Access.
3. Select the definition that connects FortiClient to the FortiGate dialup server, select the Settings icon, and select

Edit the selected connection.
4. In the Edit VPN Connection dialog box, select Advanced Settings.
5. In the Remote Network group, select Add.
6. In the IP and Subnet Mask fields, type 0.0.0.0/0.0.0.0 and select OK.

The address is added to the Remote Network list. The first destination IP address in the list establishes a
VPN tunnel. The second destination address (0.0.0.0/0.0.0.0 in this case) forces all other traffic
through the VPN tunnel.

7. Select OK.
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This section discusses the options for supporting redundant and partially redundant IPsec VPNs, using route-
based approaches.

The following topics are included in this section:

Configuration overview
A FortiGate unit with two interfaces connected to the Internet can be configured to support redundant VPNs to
the same remote peer. If the primary connection fails, the FortiGate unit can establish a VPN using the other
connection.

Redundant tunnels do not support Tunnel Mode or manual keys. You must use Interface Mode.

A fully-redundant configuration requires redundant connections to the Internet on both peers. The figure below
shows an example of this. This is useful to create a reliable connection between two FortiGate units with static IP
addresses.

When only one peer has redundant connections, the configuration is partially-redundant. For an example of this,
see Configuration overview on page 2150. This is useful to provide reliable service from a FortiGate unit with
static IP addresses that accepts connections from dialup IPsec VPN clients.

In a fully-redundant VPN configuration with two interfaces on each peer, four distinct paths are possible for VPN
traffic from end to end. Each interface on a peer can communicate with both interfaces on the other peer. This
ensures that a VPN will be available as long as each peer has one working connection to the Internet.

You configure a VPN and an entry in the routing table for each of the four paths. All of these VPNs are ready to
carry data. You set different routing distances for each route and only the shortest distance route is used. If this
route fails, the route with the next shortest distance is used.

The redundant configurations described in this chapter use route-based VPNs, otherwise known as virtual IPsec
interfaces. This means that the FortiGate unit must operate in NAT mode. You must use auto-keying. A VPN that
is created using manual keys cannot be included in a redundant-tunnel configuration.

The configuration described here assumes that your redundant VPNs are essentially equal in cost and capability.
When the original VPN returns to service, traffic continues to use the replacement VPN until the replacement VPN
fails. If your redundant VPN uses more expensive facilities, you want to use it only as a backup while the main
VPN is down. For information on how to do this, see Configuration overview on page 2150.
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Example redundant-tunnel configuration

A VPN that is created using manual keys cannot be included in a redundant-tunnel configuration.

General configuration steps

A redundant configuration at each VPN peer includes:

l One Phase 1 configuration (virtual IPsec interface) for each path between the two peers. In a fully-meshed
redundant configuration, each network interface on one peer can communicate with each network interface on the
remote peer. If both peers have two public interfaces, this means that each peer has four paths, for example.

l One Phase 2 definition for each Phase 1 configuration.
l One static route for each IPsec interface, with different distance values to prioritize the routes.
l Two Accept security policies per IPsec interface, one for each direction of traffic.
l Dead peer detection enabled in each Phase 1 definition.

The procedures in this section assume that two separate interfaces to the Internet are available on each VPN
peer.
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Configuring the VPN peers - route-based VPN

VPN peers are configured using Interface Mode for redundant tunnels.

Configure each VPN peer as follows:

1. Ensure that the interfaces used in the VPN have static IP addresses.
2. Create a Phase 1 configuration for each of the paths between the peers.
3. Enable dead peer detection so that one of the other paths is activated if this path fails.
4. Enter these settings in particular, and any other VPN settings as required:

Path 1

Remote Gateway Select Static IP Address.

IP Address Type the IP address of the primary interface of the remote peer.

Local Interface Select the primary public interface of this peer.

Dead Peer Detection Enable

Path 2

Remote Gateway Select Static IP Address.

IP Address Type the IP address of the secondary interface of the remote peer.

Local Interface Select the primary public interface of this peer.

Dead Peer Detection Enable

Path 3

Remote Gateway Select Static IP Address.

IP Address Type the IP address of the primary interface of the remote peer.

Local Interface Select the secondary public interface of this peer.

Dead Peer Detection Enable

Path 4

Remote Gateway Select Static IP Address.

IP Address Type the IP address of the secondary interface of the remote peer.

Local Interface Select the secondary public interface of this peer.

Dead Peer Detection Enable

For more information, see Phase 1 parameters on page 2048.
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5. Create a Phase 2 definition for each path. See Phase 2 parameters on page 2067. Select the Phase 1
configuration (virtual IPsec interface) that you defined for this path. You can select the name from the Static IP
Address part of the list.

6. Create a route for each path to the other peer. If there are two ports on each peer, there are four possible paths
between the peer devices.

Destination IP/Mask The IP address and netmask of the private network behind the remote
peer.

Device One of the virtual IPsec interfaces on the local peer.

Distance For each path, enter a different value to prioritize the paths.

7. Define the security policy for the local primary interface. See Defining VPN security policies on page 1. You need
to create two policies for each path to enable communication in both directions. Enter these settings in particular:

Incoming Interface Select the local interface to the internal (private) network.

Source Address All

Outgoing Interface Select one of the virtual IPsec interfaces you created in Step 2.

Destination Address All

Schedule Always

Service Any

Action ACCEPT

8. Select Create New, leave the Policy Type as Firewall and leave the Policy Subtype asAddress, and enter
these settings:

Incoming Interface Select one of the virtual IPsec interfaces you created in Step 2.

Source Address All

Outgoing Interface Select the local interface to the internal (private) network.

Destination Address All

Schedule Always

Service Any

Action ACCEPT

9. Place the policy in the policy list above any other policies having similar source and destination addresses.
10. Repeat this procedure at the remote FortiGate unit.

2153 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Redundant VPN configurations

Creating a backup IPsec interface

You can configure a route-based VPN that acts as a backup facility to another VPN. It is used only while your main
VPN is out of service. This is desirable when the redundant VPN uses a more expensive facility.

You can configure a backup IPsec interface only in the CLI. The backup feature works only on interfaces with
static addresses that have dead peer detection enabled. The monitor option creates a backup VPN for the
specified Phase 1 configuration.

In the following example, backup_vpn is a backup for main_vpn.

config vpn ipsec phase1-interface
edit main_vpn

set dpd on
set interface port1
set nattraversal enable
set psksecret "hard-to-guess"
set remote-gw 192.168.10.8
set type static

end
edit backup_vpn

set dpd on
set interface port2
set monitor main_vpn
set nattraversal enable
set psksecret "hard-to-guess"
set remote-gw 192.168.10.8
set type static

end
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This section describes transparent VPN configurations, in which two FortiGate units create a VPN tunnel between
two separate private networks transparently.

The following topics are included in this section:

Configuration overview
In transparent mode, all interfaces of the FortiGate unit except the management interface (which by default is
assigned IP address 10.10.10.1/255.255.255.0) are invisible at the network layer. Typically, when a FortiGate
unit runs in transparent mode, different network segments are connected to the FortiGate interfaces. The figure
below shows the management station on the same subnet. The management station can connect to the
FortiGate unit directly through the web-based manager.

Management station on internal network

An edge router typically provides a public connection to the Internet and one interface of the FortiGate unit is
connected to the router. If the FortiGate unit is managed from an external address (see the figure below), the
router must translate (NAT) a routable address to direct management traffic to the FortiGate management
interface.

Management station on external network
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In a transparent VPN configuration, two FortiGate units create a VPN tunnel between two separate private
networks transparently. All traffic between the two networks is encrypted and protected by FortiGate security
policies.

Both FortiGate units may be running in transparent mode, or one could be running in transparent mode and the
other running in NAT mode. If the remote peer is running in NAT mode, it must have a static public IP address.

VPNs between two FortiGate units running in transparent mode do not support
inbound/outbound NAT (supported through CLI commands) within the tunnel. In
addition, a FortiGate unit running in transparent mode cannot be used in a hub-and-
spoke configuration.

Encrypted packets from the remote VPN peer are addressed to the management interface of the local FortiGate
unit. If the local FortiGate unit can reach the VPN peer locally, a static route to the VPN peer must be added to
the routing table on the local FortiGate unit. If the VPN peer connects through the Internet, encrypted packets
from the local FortiGate unit must be routed to the edge router instead. For information about how to add a static
route to the FortiGate routing table, see the Advanced Routing Guide.

In the example configuration shown above, Network Address Translation (NAT) is enabled on the router. When
an encrypted packet from the remote VPN peer arrives at the router through the Internet, the router performs
inbound NAT and forwards the packet to the FortiGate unit. Refer to the software supplier’s documentation to
configure the router.

If you want to configure a VPN between two FortiGate units running in transparent mode, each unit must have an
independent connection to a router that acts as a gateway to the Internet, and both units must be on separate
networks that have a different address space. When the two networks linked by the VPN tunnel have different
address spaces (see the figure below), at least one router must separate the two FortiGate units, unless the
packets can be redirected using ICMP (as shown in the following figure).

Link between two FortiGate units in transparent mode

In the figure below, interface C behind the router is the default gateway for both FortiGate units. Packets that
cannot be delivered on Network_1 are routed to interface C by default. Similarly, packets that cannot be delivered
on Network_2 are routed to interface C. In this case, the router must be configured to redirect packets destined
for Network_1 to interface A and redirect packets destined for Network_2 to interface B.
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ICMP redirecting packets to two FortiGate units in transparent mode

If there are additional routers behind the FortiGate unit (see the figure below) and the destination IP address of
an inbound packet is on a network behind one of those routers, the FortiGate routing table must include routes to
those networks. For example, in the following figure, the FortiGate unit must be configured with static routes to
interfaces A and B in order to forward packets to Network_1 and Network_2 respectively.

Destinations on remote networks behind internal routers

Transparent VPN infrastructure requirements

l The local FortiGate unit must be operating in transparent mode.
l The management IP address of the local FortiGate unit specifies the local VPN gateway. The management IP

address is considered a static IP address for the local VPN peer.
l If the local FortiGate unit is managed through the Internet, or if the VPN peer connects through the Internet, the

edge router must be configured to perform inbound NAT and forward management traffic and/or encrypted packets
to the FortiGate unit.

l If the remote peer is operating in NAT mode, it must have a static public IP address.
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A FortiGate unit operating in transparent mode requires the following basic configuration to operate as a node on
the IP network:

l The unit must have sufficient routing information to reach the management station.
l For any traffic to reach external destinations, a default static route to an edge router that forwards packets to the

Internet must be present in the FortiGate routing table.
l When all of the destinations are located on the external network, the FortiGate unit may route packets using a

single default static route. If the network topology is more complex, one or more static routes in addition to the
default static route may be required in the FortiGate routing table.

Only policy-based VPN configurations are possible in transparent mode.

Before you begin

An IPsec VPN definition links a gateway with a tunnel and an IPsec policy. If your network topology includes more
than one virtual domain, you must choose components that were created in the same virtual domain. Therefore,
before you define a transparent VPN configuration, choose an appropriate virtual domain in which to create the
required interfaces, security policies, and VPN components.

Configuring the VPN peers

1. The local VPN peer need to operate in transparent mode.
To determine if your FortiGate unit is in transparent mode, go to the Dashboard > System Information widget.
Select [change]. Select transparent for theOperation Mode. Two new fields will appear to enter the
Management IP/Netmask, and the Default Gateway.
In transparent mode, the FortiGate unit is invisible to the network. All of its interfaces are on the same subnet and
share the same IP address. You only have to configure a management IP address so that you can make
configuration changes.

The remote VPN peer may operate in NAT mode or transparent mode.
2. At the local FortiGate unit, define the Phase 1 parameters needed to establish a secure connection with the

remote peer. See Phase 1 parameters on page 2048. Select Advanced and enter these settings in particular:

Remote Gateway Select Static IP Address.

IP Address Type the IP address of the public interface to the remote peer. If the
remote peer is a FortiGate unit running in transparent mode, type the IP
address of the remote management interface.

Advanced Select Nat-traversal, and type a value into the Keepalive Frequency
field. These settings protect the headers of encrypted packets from being
altered by external NAT devices and ensure that NAT address mappings do
not change while the VPN tunnel is open. For more information, see Phase
1 parameters on page 2048 and Phase 1 parameters on page 2048.

3. Define the Phase 2 parameters needed to create a VPN tunnel with the remote peer. See Phase 2 parameters on
page 2067. Select the set of Phase 1 parameters that you defined for the remote peer. The name of the remote
peer can be selected from the Static IP Address list.

4. Define the source and destination addresses of the IP packets that are to be transported through the VPN tunnel.
See Defining VPN security policies on page 1. Enter these settings in particular:
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l For the originating address (source address), enter the IP address and netmask of the private network behind
the local peer network. for the management interface, for example, 10.10.10.0/24. This address needs to
be a range to allow traffic from your network through the tunnel. Optionally select any for this address.

l For the remote address (destination address), enter the IP address and netmask of the private network behind
the remote peer (for example, 192.168.10.0/24). If the remote peer is a FortiGate unit running in
transparent mode, enter the IP address of the remote management interface instead.

5. Define an IPsec security policy to permit communications between the source and destination addresses. See
Defining VPN security policies on page 1. Enter these settings in particular:

Incoming Interface Select the local interface to the internal (private) network.

Source Address Select the source address that you defined in Step 4.

Outgoing Interface Select the interface to the edge router. When you configure the IPsec
security policy on a remote peer that operates in NAT mode, you select the
public interface to the external (public) network instead.

Destination Address Select the destination address that you defined in Step 4.

VPN Tunnel Select Use Existing and select the name of the Phase 2 tunnel
configuration that you created in Step 3 from the drop-down list.

Select Allow traffic to be initiated from the remote site to enable
traffic from the remote network to initiate the tunnel.

6. Place the policy in the policy list above any other policies having similar source and destination addresses.
7. Define another IPsec security policy to permit communications between the source and destination addresses in

the opposite direction. This security policy and the previous one form a bi-directional policy pair. See Defining VPN
security policies on page 1. Enter these settings in particular:

Incoming Interface Select the interface to the edge router. When you configure the IPsec
security policy on a remote peer that operates in NAT mode, you select the
public interface to the external (public) network instead.

Source Address Select the destination address that you defined in Step 4..

Outgoing Interface Select the local interface to the internal (private) network.

Destination Address Select the source address that you defined in Step 4.

VPN Tunnel Select Use Existing and select the name of the Phase 2 tunnel
configuration that you created in Step 3 from the drop-down list.

Select Allow traffic to be initiated from the remote site to enable
traffic from the remote network to initiate the tunnel.

8. Repeat this procedure at the remote FortiGate unit to create bidirectional security policies. Use the local interface
and address information local to the remote FortiGate unit.
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This chapter describes how to configure your FortiGate unit’s IPv6 IPsec VPN functionality.

By default IPv6 configurations to not appear on the Web-based Manager. You need to
enable the feature first.

To enable IPv6

1. Go to System > Feature Visibility.
2. Enable IPv6.
3. Select Apply.

The following topics are included in this section:

IPv6 IPsec support

FortiOS supports route-based IPv6 IPsec, but not policy-based. This section describes how IPv6 IPsec support
differs from IPv4 IPsec support. FortiOS 4.0 MR3 is IPv6 Ready Logo Program Phase 2 certified.

Where both the gateways and the protected networks use IPv6 addresses, sometimes called IPv6 over IPv6, you
can create either an auto-keyed or manually-keyed VPN. You can combine IPv6 and IPv4 addressing in an auto-
keyed VPN in the following ways:

IPv4 over IPv6 The VPN gateways have IPv6 addresses.

The protected networks have IPv4 addresses. The Phase 2 configurations
at either end use IPv4 selectors.

IPv6 over IPv4

The VPN gateways have IPv4 addresses.

The protected networks use IPv6 addresses. The Phase 2 configurations at
either end use IPv6 selectors.

Compared with IPv4 IPsec VPN functionality, there are some limitations:

l Except for IPv6 over IPv4, remote gateways with Dynamic DNS are not supported.
l Selectors cannot be firewall address names. Only IP address, address range and subnet are supported.
l Redundant IPv6 tunnels are not supported.

Certificates

On a VPN with IPv6 Phase 1 configuration, you can authenticate using VPN certificates in which the common
name (cn) is an IPv6 address. The cn-type keyword of the user peer command has an option, ipv6, to
support this.
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Configuration examples
This section consists of the following configuration examples:

l Site-to-site IPv6 over IPv6 VPN example
l Site-to-site IPv6 over IPv4 VPN example
l Site-to-site IPv4 over IPv6 VPN example

Site-to-site IPv6 over IPv6 VPN example

In this example, computers on IPv6-addressed private networks communicate securely over public IPv6
infrastructure.

By default IPv6 configurations to not appear on the Web-based Manager. You need to
enable the feature first.

To enable IPv6

1. Go to System > Feature Visibility.
2. Enable IPv6.
3. Select Apply.

Example IPv6-over-IPv6 VPN topology

Configure FortiGate A interfaces

Port 2 connects to the public network and port 3 connects to the local network.

config system interface
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edit port2
config ipv6

set ip6-address fec0::0001:209:0fff:fe83:25f2/64
end

next
edit port3

config ipv6
set ip6-address fec0::0000:209:0fff:fe83:25f3/64

end
next

end

Configure FortiGate A IPsec settings

The Phase 1 configuration creates a virtual IPsec interface on port 2 and sets the remote gateway to the public IP
address FortiGate B. This configuration is the same as for an IPv4 route-based VPN, except that ip-version is
set to 6 and the remote-gw6 keyword is used to specify an IPv6 remote gateway address.

config vpn ipsec phase1-interface
edit toB

set ip-version 6
set interface port2
set remote-gw6 fec0:0000:0000:0003:209:0fff:fe83:25c7
set dpd [disable | on-idle | on-demand]
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end

By default, Phase 2 selectors are set to accept all subnet addresses for source and destination. The default
setting for src-addr-type and dst-addr-type is subnet. The IPv6 equivalent is subnet6. The default
subnet addresses are 0.0.0.0/0 for IPv4, ::/0 for IPv6.

config vpn ipsec phase2-interface
edit toB2

set phase1name toB
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end

Configure FortiGate A security policies

Security policies are required to allow traffic between port3 and the IPsec interface toB in each direction. The
address all6must be defined using the firewall address6 command as ::/0.

config firewall policy6
edit 1

set srcintf port3
set dstintf toB
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
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edit 2
set srcintf toB
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end

Configure FortiGate A routing

This simple example requires just two static routes. Traffic to the protected network behind FortiGate B is routed
via the virtual IPsec interface toB. A default route sends all IPv6 traffic out on port2.

config router static6
edit 1

set device port2
set dst 0::/0

next
edit 2

set device toB
set dst fec0:0000:0000:0004::/64

end

Configure FortiGate B

The configuration of FortiGate B is very similar to that of FortiGate A. A virtual IPsec interface toA is configured
on port2 and its remote gateway is the public IP address of FortiGate A. Security policies enable traffic to pass
between the private network and the IPsec interface. Routing ensures traffic for the private network behind
FortiGate A goes through the VPN and that all IPv6 packets are routed to the public network.

config system interface
edit port2

config ipv6
set ip6-address fec0::0003:209:0fff:fe83:25c7/64

end
next
edit port3

config ipv6
set ip6-address fec0::0004:209:0fff:fe83:2569/64

end
end

config vpn ipsec phase1-interface
edit toA

set ip-version 6
set interface port2
set remote-gw6 fec0:0000:0000:0001:209:0fff:fe83:25f2
set dpd [disable | on-idle | on-demand]
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end
config vpn ipsec phase2-interface

edit toA2
set phase1name toA
set proposal 3des-md5 3des-sha1
set pfs enable
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set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end
config firewall policy6

edit 1
set srcintf port3
set dstintf toA
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toA
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end
config router static6

edit 1
set device port2
set dst 0::/0

next
edit 2

set device toA
set dst fec0:0000:0000:0000::/64

end

Site-to-site IPv6 over IPv4 VPN example

In this example, IPv6-addressed private networks communicate securely over IPv4 public infrastructure.
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Example IPv6-over-IPv4 VPN topology

Configure FortiGate A interfaces

Port 2 connects to the IPv4 public network and port 3 connects to the IPv6 LAN.

config system interface
edit port2

set 10.0.0.1/24
next
edit port3
config ipv6

set ip6-address fec0::0001:209:0fff:fe83:25f3/64
end

Configure FortiGate A IPsec settings

The Phase 1 configuration uses IPv4 addressing.

config vpn ipsec phase1-interface
edit toB

set interface port2
set remote-gw 10.0.1.1
set dpd [disable | on-idle | on-demand]
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end
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The Phase 2 configuration uses IPv6 selectors. By default, Phase 2 selectors are set to accept all subnet
addresses for source and destination. The default setting for src-addr-type and dst-addr-type is
subnet. The IPv6 equivalent is subnet6. The default subnet addresses are 0.0.0.0/0 for IPv4, ::/0 for IPv6.

config vpn ipsec phase2-interface
edit toB2

set phase1name toB
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end

Configure FortiGate A security policies

IPv6 security policies are required to allow traffic between port3 and the IPsec interface toB in each direction.
Define the address all6 using the firewall address6 command as ::/0.

config firewall policy6
edit 1

set srcintf port3
set dstintf toB
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toB
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end

Configure FortiGate A routing

This simple example requires just two static routes. Traffic to the protected network behind FortiGate B is routed
via the virtual IPsec interface toB using an IPv6 static route. A default route sends all IPv4 traffic, including the
IPv4 IPsec packets, out on port2.

config router static6
edit 1

set device toB
set dst fec0:0000:0000:0004::/64

end
config router static

edit 1
set device port2
set dst 0.0.0.0/0
set gateway 10.0.0.254

end
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Configure FortiGate B

The configuration of FortiGate B is very similar to that of FortiGate A. A virtual IPsec interface toA is configured
on port2 and its remote gateway is the IPv4 public IP address of FortiGate A. The IPsec Phase 2 configuration
has IPv6 selectors.

IPv6 security policies enable traffic to pass between the private network and the IPsec interface. An IPv6 static
route ensures traffic for the private network behind FortiGate A goes through the VPN and an IPv4 static route
ensures that all IPv4 packets are routed to the public network.

config system interface
edit port2

set 10.0.1.1/24
next
edit port3

config ipv6
set ip6-address fec0::0004:209:0fff:fe83:2569/64

end
config vpn ipsec phase1-interface

edit toA
set interface port2
set remote-gw 10.0.0.1
set dpd [disable | on-idle | on-demand]
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end
config vpn ipsec phase2-interface

edit toA2
set phase1name toA
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end
config firewall policy6

edit 1
set srcintf port3
set dstintf toA
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toA
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end
config router static6

edit 1
set device toA
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set dst fec0:0000:0000:0000::/64
end

config router static
edit 1

set device port2
set gateway 10.0.1.254

end

Site-to-site IPv4 over IPv6 VPN example

In this example, two private networks with IPv4 addressing communicate securely over IPv6 infrastructure.

Example IPv4-over-IPv6 VPN topology

Configure FortiGate A interfaces

Port 2 connects to the IPv6 public network and port 3 connects to the IPv4 LAN.

config system interface
edit port2

config ipv6
set ip6-address fec0::0001:209:0fff:fe83:25f2/64

end
next
edit port3

set 192.168.2.1/24
end

Configure FortiGate A IPsec settings

The Phase 1 configuration is the same as in the IPv6 over IPv6 example.
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config vpn ipsec phase1-interface
edit toB

set ip-version 6
set interface port2
set remote-gw6 fec0:0000:0000:0003:209:0fff:fe83:25c7
set dpd [disable | on-idle | on-demand]
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end

The Phase 2 configuration is the same as you would use for an IPv4 VPN. By default, Phase 2 selectors are set to
accept all subnet addresses for source and destination.

config vpn ipsec phase2-interface
edit toB2

set phase1name toB
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable

end

Configure FortiGate A security policies

Security policies are required to allow traffic between port3 and the IPsec interface toB in each direction. These
are IPv4 security policies.

config firewall policy
edit 1

set srcintf port3
set dstintf toB
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toB
set dstintf port3
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always

end

Configure FortiGate A routing

This simple example requires just two static routes. Traffic to the protected network behind FortiGate B is routed
via the virtual IPsec interface toB using an IPv4 static route. A default route sends all IPv6 traffic, including the
IPv6 IPsec packets, out on port2.

config router static6
edit 1

set device port2
set dst 0::/0

next
edit 2
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set device toB
set dst 192.168.3.0/24

end

Configure FortiGate B

The configuration of FortiGate B is very similar to that of FortiGate A. A virtual IPsec interface toA is configured
on port2 and its remote gateway is the public IP address of FortiGate A. The IPsec Phase 2 configuration has
IPv4 selectors.

IPv4 security policies enable traffic to pass between the private network and the IPsec interface. An IPv4 static
route ensures traffic for the private network behind FortiGate A goes through the VPN and an IPv6 static route
ensures that all IPv6 packets are routed to the public network.

config system interface
edit port2

config ipv6
set ip6-address fec0::0003:fe83:25c7/64

end
next
edit port3

set 192.168.3.1/24
end

config vpn ipsec phase1-interface
edit toA

set ip-version 6
set interface port2
set remote-gw6 fec0:0000:0000:0001:209:0fff:fe83:25f2
set dpd [disable | on-idle | on-demand]
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end
config vpn ipsec phase2-interface

edit toA2
set phase1name toA
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable

end
config firewall policy

edit 1
set srcintf port3
set dstintf toA
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toA
set dstintf port3
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always
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end
config router static6

edit 1
set device port2
set dst 0::/0

next
edit 2

set device toA
set dst 192.168.2.0/24

end
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This section describes how to set up a VPN that is compatible with the Microsoft Windows native VPN, which is
Layer 2 Tunneling Protocol (L2TP) with IPsec encryption.

The following topics are included in this section:

For troubleshooting information, refer to Troubleshooting L2TP and IPsec.

Overview
The topology of a VPN for Microsoft Windows dialup clients is very similar to the topology for FortiClient Endpoint
Security clients.

Example FortiGate VPN configuration with Microsoft clients

For users, the difference is that instead of installing and using the FortiClient application, they configure a
network connection using the software built into the Microsoft Windows operating system. Starting in FortiOS 4.0
MR2, you can configure a FortiGate unit to work with unmodified Microsoft VPN client software.
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Layer 2 Tunneling Protocol (L2TP)

L2TP is a tunneling protocol published in 1999 that is used with VPNs, as the name suggests. Microsoft Windows
operating system has a built-in L2TP client starting since Windows 2000. Mac OS X 10.3 system and higher also
have a built-in client.

L2TP provides no encryption and used UDP port 1701. IPsec is used to secure L2TP packets. The initiator of the
L2TP tunnel is called the L2TP Access Concentrator (LAC).

L2TP and IPsec is supported for native Windows XP, Windows Vista and Mac OSX native VPN clients. However,
in Mac OSX (OSX 10.6.3, including patch releases) the L2TP feature does not work properly on the Mac OS side.

Assumptions
The following assumptions have been made for this example:

l L2TP protocol traffic is allowed through network firewalls (TCP and UDP port 1701)
l User has Microsoft Windows 2000 or higher — aWindows version that supports L2TP

Configuration overview
The following section consists of configuring the FortiGate unit and configuring the Windows PC.

Configuring the FortiGate unit

To configure the FortiGate unit, you must:

l Configure LT2P users and firewall user group.
l Configure the L2TP VPN, including the IP address range it assigns to clients.
l Configure an IPsec VPN with encryption and authentication settings that match the Microsoft VPN client.
l Configure security policies.

Configuring LT2P users and firewall user group

Remote users must be authenticated before they can request services and/or access network resources through
the VPN. The authentication process can use a password defined on the FortiGate unit or an established external
authentication mechanism such as RADIUS or LDAP.

Creating user accounts

You need to create user accounts and then add these users to a firewall user group to be used for L2TP
authentication. The Microsoft VPN client can automatically send the user’s Window network logon credentials.
You might want to use these for their L2TP user name and password.

Creating a user account - web-based manager

1. Go to User & Device > User Definitionand select Create New.
2. Enter the User Name.
3. Do one of the following:

l Select Password and enter the user’s assigned password.
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l Select Match user on LDAP server, Match user on RADIUS server, orMatch user onTACACS+
server and select the authentication server from the list. The authentication server must be already configured
on the FortiGate unit.

4. Select OK.

Creating a user account - CLI

To create a user account called user1 with the password 123_user, enter:

config user local
edit user1

set type password
set passwd "123_user"
set status enable

end

Creating a user group

When clients connect using the L2TP-over-IPsec VPN, the FortiGate unit checks their credentials against the user
group you specify for L2TP authentication. You need to create a firewall user group to use for this purpose.

Creating a user group - web-based manager

1. Go to User & Device > User Groups, select Create New, and enter the following:

Name Type or edit the user group name (for example, L2TP_group).

Type Select Firewall.

Available Users/Groups The list of Local users, RADIUS servers, LDAP servers, TACACS+ servers,
or PKI users that can be added to the user group. To add a member to this
list, select the name and then select the right arrow button.

Members The list of Local users, RADIUS servers, LDAP servers, TACACS+ servers,
or PKI users that belong to the user group. To remove a member, select
the name and then select the left arrow button.

2. Select OK.

Creating a user group - CLI

To create the user group L2TP_group and add members User_1, User_2, and User_3, enter:

config user group
edit L2TP_group

set group-type firewall
set member User_1 User_2 User_3

end

Configuring L2TP

You can only configure L2TP settings in the CLI. As well as enabling L2TP, you set the range of IP address values
that are assigned to L2TP clients and specify the user group that can access the VPN. For example, to allow
access to users in the L2TP_group and assign them addresses in the range 192.168.0.50 to 192.168.0.59, enter:
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config vpn l2tp
set sip 192.168.0.50
set eip 192.168.0.59
set status enable
set usrgrp "L2TP_group"

end

One of the security policies for the L2TP over IPsec VPN uses the client address range, so you need also need to
create a firewall address for that range. For example,

config firewall address
edit L2TPclients

set type iprange
set start-ip 192.168.0.50
set end-ip 192.168.0.59

end

Alternatively, you could define this range in the web-based manager.

Configuring IPsec

The Microsoft VPN client uses IPsec for encryption. The configuration needed on the FortiGate unit is the same
as for any other IPsec VPN with the following exceptions.

l Transport mode is used instead of tunnel mode.
l The encryption and authentication proposals must be compatible with the Microsoft client.

Whether Transport mode is required depends on the configuration of the peer device
(typically an old Windows device, since newer versions of Windows don't require IPsec
and L2TP—they can run IPsec natively).

When configuring L2TP, do not name the VPN "L2TP" as that will result in a conflict.

L2TP over IPsec is supported on the FortiGate unit for both policy-based and route-based configurations, but the
following example is policy-based.

Configuring Phase 1 - web-based manager

1. Go to VPN > IPsec Tunnels and create the new custom tunnel or edit an existing tunnel.
2. Edit the Phase 1 Proposal (if it is not available, you may need to click the Convert to Custom Tunnel button).

Name Enter a name for this VPN, dialup_p1 for example.

Remote Gateway Dialup User

Local Interface Select the network interface that connects to the Internet. For example,
port1.

Mode Main (ID protection)
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Authentication Method Preshared Key

Pre-shared Key Enter the preshared key. This key must also be entered in the Microsoft
VPN client.

Advanced Select Advanced to enter the following information.

Phase 1 Proposal Enter the following Encryption/Authentication pairs:

AES256-MD5, 3DES-SHA1, AES192-SHA1

Diffie-Hellman Group 2

NAT Traversal Enable

Dead Peer Detection Enable

Configuring Phase 1 - CLI

To create a Phase 1 configuration called dialup_p1 on a FortiGate unit that has port1 connected to the Internet,
you would enter:

config vpn ipsec phase1
edit dialup_p1

set type dynamic
set interface port1
set mode main
set psksecret ********
set proposal aes256-md5 3des-sha1 aes192-sha1
set dhgrp 2
set nattraversal enable
set dpd [disable | on-idle | on-demand]

end

It is worth noting here that the command config vpn ipsec phase1 is used
rather than config vpn ipsec phase1-interface because this configuration
is policy-based and not route-based.

Configuring Phase 2 - web-based manager

1. Open the Phase 2 Selectors panel.
2. Enter the following information and then select OK.

Phase 2 Proposal Enter the following Encryption/Authentication pairs:

AES256-MD5, 3DES-SHA1, AES192-SHA1

Enable replay detection Enable

Enable perfect forward
secrecy (PFS)

Disable

Keylife 3600 seconds
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3. Make this a transport-mode VPN. You must use the CLI to do this. If your Phase 2 name is dialup_p2, you would
enter:

config vpn ipsec phase2
edit dialup_p2

set encapsulation transport-mode
end

Configuring Phase 2 - CLI

To configure a Phase 2 to work with your phase_1 configuration, you would enter:

config vpn ipsec phase2
edit dialup_p2

set phase1name dialup_p1
set proposal aes256-md5 3des-sha1 aes192-sha1
set replay enable
set pfs disable
set keylifeseconds 3600
set encapsulation transport-mode

end

Once again, note here that the command config vpn ipsec phase2 is used
rather than config vpn ipsec phase2-interface because this configuration
is policy-based and not route-based.

Configuring security policies

The security policies required for L2TP over IPsec VPN are:

l An IPsec policy, as you would create for any policy-based IPsec VPN
l A regular ACCEPT policy to allow traffic from the L2TP clients to access the protected network

Configuring the IPsec security policy - web-based manager

1. Go to System > Feature Visibility and enable Policy-based IPsec VPN.
2. Go to Policy & Objects > IPv4 Policy and select Create New.
3. Set the Action to IPsec and enter the following information:

Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Source Address All

Outgoing Interface Select the FortiGate unit’s public interface.

Destination Address All

VPN Tunnel Select Use Existing and select the name of the Phase 1 configuration that
you created. For example, dialup_p1. See Configuring IPsec on page
2175.

Allow traffic to be initiated
from the remote site

enable
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4. Select OK.

Configuring the IPsec security policy - CLI

If your VPN tunnel (Phase 1) is called dialup_p1, your protected network is on port2, and your public interface is
port1, you would enter:

config firewall policy
edit 0

set srcintf port2
set dstintf port1
set srcaddr all
set dstaddr all
set action ipsec
set schedule always
set service all
set inbound enable
set vpntunnel dialup_p1

end

Configuring the ACCEPT security policy - web-based manager

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Leave the Policy Type as Firewall and leave the Policy Subtype asAddress.
3. Enter the following information and select OK:

Incoming Interface Select the FortiGate unit’s public interface.

Source Address Select the firewall address that you defined for the L2TP clients.

Outgoing Interface Select the interface that connects to the private network behind this
FortiGate unit.

Destination Address All

Action ACCEPT

Configuring the ACCEPT security policy - CLI

If your public interface is port1, your protected network is on port2, and L2TPclients is the address range that
L2TP clients use, you would enter:

config firewall policy
edit 1

set srcintf port1
set dstintf port2
set srcaddr L2TPclients
set dstaddr all
set action accept
set schedule always
set service all

end

Configuring the Windows PC

Configuration of the Windows PC for a VPN connection to the FortiGate unit consists of the following:
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1. In Network Connections, configure a Virtual Private Network connection to the FortiGate unit.
2. Ensure that the IPSEC service is running.
3. Ensure that IPsec has not been disabled for the VPN client. It may have been disabled to make the Microsoft VPN

compatible with an earlier version of FortiOS.
The instructions in this section are based on Windows XP. Other versions of Windowsmay vary slightly.

Configuring the network connection

1. Open Network Connections.
This is available through the Control Panel.

2. Double-clickNew Connection Wizard and Select Next.
3. Select Connect to the network at my workplace.
4. Select Next.
5. Select Virtual Private Network connection and select Next.
6. In the Company Name field, enter a name for the connection and select Next.
7. Select Do not dial the initial connection and then select Next.
8. Enter the public IP address or FQDN of the FortiGate unit and select Next.
9. Optionally, select Add a shortcut to this connection to my desktop.
10. Select Finish.

The Connect dialog opens on the desktop.
11. Select Properties and then select the Security tab.
12. Select IPsec Settings.
13. Select Use pre-shared key for authentication, enter the preshared key that you configured for your VPN, and

select OK.
14. Select OK.

Checking that the IPsec service is running

1. Open Administrative Tools through the Control Panel.
2. Double-clickServices.
3. Look for IPSEC Services. Confirm that the Startup Type isAutomatic and Status is set to Started. If needed,

double-click IPsec Services to change these settings.

Checking that IPsec has not been disabled

1. Select Start > Run.
2. Enter regedit and select OK.
3. Find the Registry key HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\RasMan\Parameters
4. If there is a ProhibitIPsec value, it must be set to 0.

Enforcing IPsec in L2TP configuration

An enforce-ipsec option is available in L2TP configuration to force the FortiGate L2TP server to accept only
IPsec encrypted connections.

Syntax

config vpn l2tp
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set eip 50.0.0.100
set sip 50.0.0.1
set status enable
set enforce-ipsec-interface {disable | enable} (default = disable)
set usrgrp <group_name>

end
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This section describes how to configure a FortiGate VPN that is compatible with Cisco-style VPNs that use GRE
in an IPsec tunnel.

The following topics are included in this section:

Cisco products that include VPN support often use Generic Routing Encapsulation (GRE) protocol tunnel over
IPsec encryption. This chapter describes how to configure a FortiGate unit to work with this type of Cisco VPN.

Cisco VPNs can use either transport mode or tunnel mode IPsec. Before FortiOS 4.0 MR2, the FortiGate unit was
compatible only with tunnel mode IPsec.

Example FortiGate to Cisco GRE-over-IPsec VPN

In this example, users on LAN1 are provided access to LAN2.
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Configuration overview
The following section consists of configuring the FortiGate unit and configuring the Cisco router.

Configuring the FortiGate unit

There are several steps to the GRE-over-IPsec configuration:

l Enable overlapping subnets. This is needed because the IPsec and GRE tunnels will use the same addresses.
l Configure a route-based IPsec VPN on the external interface.
l Configure a GRE tunnel on the virtual IPsec interface. Set its local gateway and remote gateway addresses to

match the local and remote gateways of the IPsec tunnel.
l Configure security policies to allow traffic to pass in both directions between the GRE virtual interface and the IPsec

virtual interface.
l Configure security policies to allow traffic to pass in both directions between the protected network interface and the

GRE virtual interface.
l Configure a static route to direct traffic destined for the network behind the Cisco router into the GRE-over-IPsec

tunnel.

Enabling overlapping subnets

By default, each FortiGate unit network interface must be on a separate network. The configuration described in
this chapter assigns an IPsec tunnel end point and the external interface to the same network. Enable subnet
overlap as follows:

config system settings
set allow-subnet-overlap enable

end

Configuring the IPsec VPN

A route-based VPN is required. It must use encryption and authentication algorithms compatible with the Cisco
equipment to which it connects. In this chapter, preshared key authentication is shown.

Configuring the IPsec VPN - web-based manager

1. Define the Phase 1 configuration needed to establish a secure connection with the remote Cisco device. Enter
these settings in particular:

Name Enter a name to identify the VPN tunnel, tocisco for example. This is the
name of the virtual IPsec interface. It appears in Phase 2 configurations,
security policies and the VPNmonitor.

Remote Gateway Select Static IP Address.

IP Address Enter the IP address of the Cisco device public interface. For example,
192.168.5.113.

Local Interface Select the FortiGate unit’s public interface. For example, 172.20.120.141.

Mode Select Main (ID Protection).
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Authentication Method Preshared Key

Pre-shared Key Enter the preshared key. It must match the preshared key on the Cisco
device.

Advanced Select the Advanced button to see the following settings.

Phase 1 Proposal 3DES-MD5

At least one proposal must match the settings on the Cisco unit.

For more information about these settings, see Phase 1 parameters on page 2048.

2. Define the Phase 2 parameters needed to create a VPN tunnel with the remote peer. For compatibility with the
Cisco router, Quick Mode Selectors must be entered, which includes specifying protocol 47, the GRE protocol.
Enter these settings in particular:

Phase 2 Proposal 3DES-MD5

At least one proposal must match the settings on the Cisco unit.

Quick Mode Selector

Source Address Enter the GRE local tunnel end IP address.

For example 172.20.120.141.

Source Port 0

Destination Address Enter the GRE remote tunnel end IP address.

For example 192.168.5.113.

Destination Port 0

Protocol 47

For more information about these settings, see Phase 2 parameters on page 2067.

3. If the Cisco device is configured to use transport mode IPsec, you need to use transport mode on the FortiGate
VPN. You can configure this only in the CLI. In your Phase 2 configuration, set encapsulation to
transport-mode as follows:

config vpn phase2-interface
edit to_cisco_p2

set encapsulation transport-mode
end

Configuring the IPsec VPN - CLI

config vpn ipsec phase1-interface
edit tocisco

set interface port1
set proposal 3des-sha1 aes128-sha1
set remote-gw 192.168.5.113
set psksecret xxxxxxxxxxxxxxxx
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end
config vpn ipsec phase2-interface

edit tocisco_p2
set phase1name "tocisco"
set proposal 3des-md5
set encapsulation tunnel-mode // if tunnel mode
set encapsulation transport-mode // if transport mode
set protocol 47
set src-addr-type ip
set dst-start-ip 192.168.5.113
set src-start-ip 172.20.120.141

end

Adding IPsec tunnel end addresses

The Cisco configuration requires an address for its end of the IPsec tunnel. The addresses are set to match the
GRE gateway addresses. Use the CLI to set the addresses, like this:

config system interface
edit tocisco

set ip 172.20.120.141 255.255.255.255
set remote-ip 192.168.5.113

end

Configuring the GRE tunnel

The GRE tunnel runs between the virtual IPsec public interface on the FortiGate unit and the Cisco router. You
must use the CLI to configure a GRE tunnel. In the example, you would enter:

config system gre-tunnel
edit gre1

set interface tocisco
set local-gw 172.20.120.141
set remote-gw 192.168.5.113

end

interface is the virtual IPsec interface, local-gw is the FortiGate unit public IP address, and remote-gw is
the remote Cisco device public IP address

Adding GRE tunnel end addresses

You will also need to add tunnel end addresses. The Cisco router configuration requires an address for its end of
the GRE tunnel. Using the CLI, enter tunnel end addresses that are not used elsewhere on the FortiGate unit,
like this:

config system interface
edit gre1

set ip 10.0.1.1 255.255.255.255
set remote-ip 10.0.1.2

end

Configuring security policies

Two sets of security policies are required:
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l Policies to allow traffic to pass in both directions between the GRE virtual interface and the IPsec virtual interface.
l Policies to allow traffic to pass in both directions between the protected network interface and the GRE virtual

interface.

Configuring security policies - web-based manager

1. Define an ACCEPT firewall security policy to permit communications between the protected network and the GRE
tunnel:

Incoming Interface Select the interface that connects to the private network behind this
FortiGate unit.

Source Address All

Outgoing Interface Select the GRE tunnel virtual interface you configured.

Destination Address All

Action ACCEPT

Enable NAT Disable

2. To permit the remote client to initiate communication, you need to define a firewall address security policy for
communication in that direction:

Incoming Interface Select the GRE tunnel virtual interface you configured.

Source Address All

Outgoing Interface Select the interface that connects to the private network behind this
FortiGate unit.

Destination Address All

Action ACCEPT

Enable NAT Disable

3. Define a pair of ACCEPT firewall address security policies to permit traffic to flow between the GRE virtual
interface and the IPsec virtual interface:

Incoming Interface Select the GRE virtual interface. See Configuring the GRE tunnel on page
2184.

Source Address All

Outgoing Interface Select the virtual IPsec interface you created. See Configuring the IPsec
VPN on page 2182.

Destination Address All

Action ACCEPT

Enable NAT Disable
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Incoming Interface Select the virtual IPsec interface you created. See Configuring the IPsec
VPN on page 2182.

Source Address All

Outgoing Interface Select the GRE virtual interface.See Configuring the GRE tunnel on page
2184.

Destination Address All

Action ACCEPT

Enable NAT Disable

Configuring security policies - CLI

config firewall policy
edit 1 // LAN to GRE tunnel

set srcintf port2
set dstintf gre1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 2 // GRE tunnel to LAN

set srcintf gre1
set dstintf port2
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 3 // GRE tunnel to IPsec interface

set srcintf "gre1"
set dstintf "tocisco"
set srcaddr "all"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"

next
edit 4 // IPsec interface to GRE tunnel

set srcintf "tocisco"
set dstintf "gre1"
set srcaddr "all"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"

end
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Configuring routing

Traffic destined for the network behind the Cisco router must be routed to the GRE tunnel. To do this, create a
static route

1. Go to Network > Static Routes and select Create New.
2. Enter the following information and select OK.

Destination IP/Mask Enter the IP address and netmask for the network behind the Cisco router.
For example 10.21.101.0 255.255.255.0.

Device Select the GRE virtual interface.

Distance (Advanced) Leave setting at default value.

In the CLI, using the example values, you would enter

config router static
edit 0

set device gre1
set dst 10.21.101.0 255.255.255.0

end

Configuring the Cisco router
Using Cisco IOS, you would configure the Cisco router as follows, using the addresses from the example:

config ter
crypto ipsec transform-set myset esp-3des esp-md5-hmac
no mode
exit
no ip access-list extended tunnel
ip access-list extended tunnel
permit gre host 192.168.5.113 host 172.20.120.141
exit
interface Tunnel1
ip address 10.0.1.2 255.255.255.0
tunnel source 192.168.5.113
tunnel destination 172.20.120.141
!
ip route 10.11.101.0 255.255.255.0 Tunnel1
end
clea crypto sa
clea crypto isakmp

For transport mode, change no mode to mode transport.

This is only the portion of the Cisco router configuration that applies to the GRE-over-IPsec tunnel. For more
information, refer to the Cisco documentation.

Keep-alive support for GRE
The FortiGate can send a GRE keep-alive response to a Cisco device to detect a GRE tunnel. If it fails, it will
remove any routes over the GRE interface.
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Syntax

config system gre-tunnel
edit <id>

set keepalive-interval <value: 0-32767>
set keepalive-failtimes <value: 1-255>

next
end
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For enhanced security, OSPF dynamic routing can be carried over IPsec VPN links.

The following topics are included in this section:

Configuration overview
This chapter shows an example of OSPF routing conducted over an IPsec tunnel between two FortiGate units.
The network shown below is a single OSPF area. FortiGate_1 is an Area border router that advertises a static
route to 10.22.10.0/24 in OSPF. FortiGate_2 advertises its local LAN as an OSPF internal route.

OSPF over an IPsec VPN tunnel

The section Configuration overview describes the configuration with only one IPsec VPN tunnel, tunnel_wan1.
Then, the section Configuration overview describes how you can add a second tunnel to provide a redundant
backup path. This is shown above as VPN tunnel “tunnel_wan2”.

Only the parts of the configuration concerned with creating the IPsec tunnel and integrating it into the OSPF
network are described. It is assumed that security policies are already in place to allow traffic to flow between the
interfaces on each FortiGate unit.
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OSPF over IPsec configuration

There are several steps to the OSPF-over-IPsec configuration:

l Configure a route-based IPsec VPN on an external interface. It will connect to a corresponding interface on the
other FortiGate unit. Define the two tunnel-end addresses.

l Configure a static route to the other FortiGate unit.
l Configure the tunnel network as part of the OSPF network and define the virtual IPsec interface as an OSPF

interface.

This section describes the configuration with only one VPN, tunnel_wan1. The other VPN is added in the section
Configuration overview on page 2189.

Configuring the IPsec VPN

A route-based VPN is required. In this chapter, preshared key authentication is shown. Certificate authentication
is also possible. Both FortiGate units need this configuration.

Configuring Phase 1

1. Define the Phase 1 configuration needed to establish a secure connection with the other FortiGate unit. For more
information, see Phase 1 parameters on page 2048.
Enter these settings in particular:

Name Enter a name to identify the VPN tunnel, tunnel_wan1 for example. This
becomes the name of the virtual IPsec interface.

Remote Gateway Select Static IP Address.

IP Address Enter the IP address of the other FortiGate unit’s public (Port 2) interface.

Local Interface Select this FortiGate unit’s public (Port 2) interface.

Mode Select Main (ID Protection).

Authentication Method Preshared Key

Pre-shared Key Enter the preshared key. It must match the preshared key on the other
FortiGate unit.

Advanced Select Advanced.

Assigning the tunnel end IP addresses

1. Go to Network > Interfaces, select the virtual IPsec interface that you just created on Port 2 and select Edit.
2. In the IP and Remote IP fields, enter the following tunnel end addresses:

FortiGate_1 FortiGate_2

IP 10.1.1.1 10.1.1.2

Remote_IP 10.1.1.2 10.1.1.1

These addresses are from a network that is not used for anything else.
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Configuring Phase 2

1. Enter a name to identify this Phase 2 configuration, twan1_p2, for example.
2. Select the name of the Phase 1 configuration that you defined in Step "Configuration overview" on page 2189,

tunnel_wan1 for example.

Configuring static routing

You need to define the route for traffic leaving the external interface.

1. Go to Network > Static Routes, select Create New.
2. Enter the following information.

Destination IP/Mask Leave as 0.0.0.0 0.0.0.0.

Device Select the external interface.

Gateway Enter the IP address of the next hop router.

Configuring OSPF

This section does not attempt to explain OSPF router configuration. It focusses on the integration of the IPsec
tunnel into the OSPF network. This is accomplished by assigning the tunnel as an OSPF interface, creating an
OSPF route to the other FortiGate unit.

This configuration uses loopback interfaces to ease OSPF troubleshooting. The OSPF router ID is set to the
loopback interface address.The loopback interface ensures the router is always up. Even though technically the
router ID doesn’t have to match a valid IP address on the FortiGate unit, having an IP that matches the router ID
makes troubleshooting a lot easier.

The two FortiGate units have slightly different configurations. FortiGate_1 is an AS border router that advertises
its static default route. FortiGate_2 advertises its local LAN as an OSPF internal route.

Setting the router ID for each FortiGate unit to the lowest possible value is useful if you want the FortiGate units
to be the designated router (DR) for their respective ASes. This is the router that broadcasts the updates for the
AS.

Leaving the IP address on the OSPF interface at 0.0.0.0 indicates that all potential routes will be advertised, and
it will not be limited to any specific subnet. For example if this IP address was 10.1.0.0, then only routes that
match that subnet will be advertised through this interface in OSPF.

FortiGate_1 OSPF configuration

When configuring FortiGate_1 for OSPF, the loopback interface is created, and then you configure OSPF area
networks and interfaces.

With the exception of creating the loopback interface, OSPF for this example can all be configured in either the
web-based manager or CLI.

Creating the loopback interface

A loopback interface can be configured in the CLI only. For example, if the interface will have an IP address of
10.0.0.1, you would enter:

config system interface
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edit lback1
set vdom root

set ip 10.0.0.1 255.255.255.255
set type loopback

end

The loopback addresses and corresponding router IDs on the two FortiGate units must be different. For example,
set the FortiGate 1 loopback to 10.0.0.1 and the FortiGate 2 loopback to 10.0.0.2.

Configuring OSPF area, networks, and interfaces - web-based manager

1. On FortiGate_1, go to Network > OSPF.
2. Enter the following information to define the router, area, and interface information.

Router ID Enter 10.0.0.1. Select Apply before entering the remaining
information.

Advanced Options

Redistribute Select the Connected and Static check boxes. Use their default metric
values.

Areas Select Create New, enter the Area and Type and then select OK.

Area 0.0.0.0

Type Regular

Interfaces Enter a name for the OSPF interface, ospf_wan1 for example.

Name

Interface Select the virtual IPsec interface, tunnel_wan1.

IP 0.0.0.0

3. ForNetworks, select Create New.
4. Enter the IP/Netmask of 10.1.1.0/255.255.255.0 and an Area of 0.0.0.0.
5. ForNetworks, select Create New.
6. Enter the IP/Netmask of 10.0.0.1/255.255.255.0 and an Area of 0.0.0.0.
7. Select Apply.

Configuring OSPF area and interfaces - CLI

Your loopback interface is 10.0.0.1, your tunnel ends are on the 10.1.1.0/24 network, and your virtual IPsec
interface is named tunnel_wan1. Enter the following CLI commands:

config router ospf
set router-id 10.0.0.1
config area

edit 0.0.0.0
end
config network

edit 4
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set prefix 10.1.1.0 255.255.255.0
next
edit 2

set prefix 10.0.0.1 255.255.255.255
end

config ospf-interface
edit ospf_wan1

set cost 10
set interface tunnel_wan1
set network-type point-to-point

end
config redistribute connected

set status enable
end
config redistribute static

set status enable
end

end

FortiGate_2 OSPF configuration

When configuring FortiGate_2 for OSPF, the loopback interface is created, and then you configure OSPF area
networks and interfaces.

Configuring FortiGate_2 differs from FortiGate_1 in that three interfaces are defined instead of two. The third
interface is the local LAN that will be advertised into OSPF.

With the exception of creating the loopback interface, OSPF for this example can all be configured in either the
web-based manager or CLI.

Creating the loopback interface

A loopback interface can be configured in the CLI only. For example, if the interface will have an IP address of
10.0.0.2, you would enter:

config system interface
edit lback1

set vdom root
set ip 10.0.0.2 255.255.255.255
set type loopback

end

The loopback addresses on the two FortiGate units must be different. For example, set the FortiGate 1 loopback
to 10.0.0.1 and the FortiGate 2 loopback to 10.0.0.2.

Configuring OSPF area and interfaces - web-based manager

1. On FortiGate_2, go to Network > OSPF.
2. Complete the following.

Router ID 10.0.0.2

Areas Select Create New, enter the Area and Type and then select OK.

Area 0.0.0.0
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Type Regular

Interfaces

Name Enter a name for the OSPF interface, ospf_wan1 for example.

Interface Select the virtual IPsec interface, tunnel_wan1.

IP 0.0.0.0

3. ForNetworks, select Create New.
4. Enter the following information for the loopback interface:

IP/Netmask 10.0.0.2/255.255.255.255

Area 0.0.0.0

5. ForNetworks, select Create New.
6. Enter the following information for the tunnel interface:

IP/Netmask 10.1.1.0/255.255.255.255

Area 0.0.0.0

7. ForNetworks, select Create New.
8. Enter the following information for the local LAN interface:

IP/Netmask 10.31.101.0/255.255.255.255

Area 0.0.0.0

9. Select Apply.

Configuring OSPF area and interfaces - CLI

If for example, your loopback interface is 10.0.0.2, your tunnel ends are on the 10.1.1.0/24 network, your local
LAN is 10.31.101.0/24, and your virtual IPsec interface is named tunnel_wan1, you would enter:

config router ospf
set router-id 10.0.0.2
config area

edit 0.0.0.0
end
config network

edit 1
set prefix 10.1.1.0 255.255.255.0

next
edit 2

set prefix 10.31.101.0 255.255.255.0
next
edit 2

set prefix 10.0.0.2 255.255.255.255
end
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config ospf-interface
edit ospf_wan1

set interface tunnel_wan1
set network-type point-to-point

end
end

Creating a redundant configuration

You can improve the reliability of the OSPF over IPsec configuration described in the previous section by adding a
second IPsec tunnel to use if the default one goes down. Redundancy in this case is not controlled by the IPsec
VPN configuration but by the OSPF routing protocol.

To do this you:

l Create a second route-based IPsec tunnel on a different interface and define tunnel end addresses for it.
l Add the tunnel network as part of the OSPF network and define the virtual IPsec interface as an additional OSPF

interface.
l Set the OSPF cost for the added OSPF interface to be significantly higher than the cost of the default route.

Adding the second IPsec tunnel

The configuration is the same as in Configuring the IPsec VPN on page 2190, but the interface and addresses will
be different. Ideally, the network interface you use is connected to a different Internet service provider for added
redundancy.

When adding the second tunnel to the OSPF network, choose another unused subnet for the tunnel ends,
10.1.2.1 and 10.1.2.2 for example.

Adding the OSPF interface

OSPF uses the metric called cost when determining the best route, with lower costs being preferred. Up to now in
this example, only the default cost of 10 has been used. Cost can be set only in the CLI.

The new IPsec tunnel will have its OSPF cost set higher than that of the default tunnel to ensure that it is only
used if the first tunnel goes down. The new tunnel could be set to a cost of 200 compared to the default cost is
10. Such a large difference in cost will ensure this new tunnel will only be used as a last resort.

If the new tunnel is called tunnel_wan2, you would enter the following on both FortiGate units:

config router ospf
config ospf-interface

edit ospf_wan2
set cost 200
set interface tunnel_wan2
set network-type point-to-point

end
end
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This example sets up redundant secure communication between two remote networks using an Open Shortest
Path First (OSPF) VPN connection. In this example, the HQ FortiGate unit will be called FortiGate 1 and the
Branch FortiGate unit will be called FortiGate 2.

The steps include:

1. Creating redundant IPsec tunnels on FortiGate 1.
2. Configuring IP addresses and OSPF on FortiGate 1.
3. Configuring firewall addresses on FortiGate 1.
4. Configuring security policies on FortiGate 1.
5. Creating redundant IPsec tunnels for FortiGate 2.
6. Configuring IP addresses and OSPF on FortiGate 2.
7. Configuring firewall addresses on FortiGate 2.
8. Configuring security policies on FortiGate 2.

Creating redundant IPsec tunnels on FortiGate 1
1. Go to VPN > IPsec Tunnels.
2. Select Create New, name the primary tunnel and select Custom VPN Tunnel (No Template).
3. Set the following:

Remote Gateway Static IP Address

IP Address FortiGate 2’s wan1 IP

Local Interface wan1 (the primary Internet-facing interface)

Pre-shared Key Enter

4. Go to VPN > IPsec Tunnels.
5. Select Create New, name the secondary tunnel and select Custom VPN Tunnel (No Template).
6. Set the following:

Remote Gateway Static IP Address

IP Address FortiGate 2’s wan2 IP

Local Interface wan2 (the secondary Internet-facing interface)

Pre-shared Key Enter

Configuring IP addresses and OSPF on FortiGate 1
1. Go to Network > Interfaces.
2. Select the arrow forwan1 to expand the list.
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3. Edit the primary tunnel interface and create IP addresses.

IP 10.1.1.1

Remote IP 10.1.1.2

4. Select the arrow forwan2 to expand the list.
5. Edit the secondary tunnel interface and create IP addresses.

IP 10.2.1.1

Remote IP 10.2.1.2

6. Go to Network > OSPF and enter the Router ID for FortiGate 1.
7. Select Create New in the Area section.
8. Add the backbone area of 0.0.0.0.
9. Select Create New in the Networks section.
10. Create the networks and select Area 0.0.0.0 for each one.
11. Select Create New in the Interfaces section.
12. Create primary and secondary tunnel interfaces.
13. Set a Cost of 10 for the primary interface and 100 for the secondary interface.

Configuring firewall addresses on FortiGate 1
1. Go to Policy & Objects > Addresses.
2. Create/Edit the subnets behind FortiGate 1 and FortiGate 2.
3. Create/Edit the primary and secondary interfaces of FortiGate 2.

Configuring security policies on FortiGate 1
1. Go to Policy & Objects > IPv4 Policy.
2. Create the four security policies required for both FortiGate 1’s primary and secondary interfaces to connect to

FortiGate 2’s primary and secondary interfaces.

Creating redundant IPsec tunnels on FortiGate 2
1. Go to VPN > IPsec Tunnels.
2. Select Create New, name the primary tunnel and select Custom VPN Tunnel (No Template).
3. Set the following:

Remote Gateway Static IP Address

IP Address FortiGate 1’s wan1 IP

Local Interface wan1 (the primary Internet-facing interface)

Pre-shared Key Enter
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4. Go to VPN > IPsec Tunnels.
5. Select Create New, name the secondary tunnel and select Custom VPN Tunnel (No Template).
6. Set the following:

Remote Gateway Static IP Address

IP Address FortiGate 1’s wan1 IP

Local Interface wan2 (the secondary Internet-facing interface)

Pre-shared Key Enter

Configuring IP addresses and OSPF on FortiGate 1
1. Go to Network > Interfaces.
2. Select the arrow forwan1 to expand the list.
3. Edit the primary tunnel interface and create IP addresses.

IP 10.1.1.2

Remote IP 10.1.1.1

4. Select the arrow forwan2 to expand the list.
5. Edit the secondary tunnel interface and create IP addresses.

IP 10.2.1.2

Remote IP 10.2.1.1

6. Go to Network > OSPF and enter the Router ID for FortiGate 2.
7. Select Create New in the Area section.
8. Add the backbone area of 0.0.0.0.
9. Select Create New in the Networks section.
10. Create the networks and select Area 0.0.0.0 for each one.
11. Select Create New in the Interfaces section.
12. Create primary and secondary tunnel interfaces.
13. Set a Cost of 10 for the primary interface and 100 for the secondary interface.

Configuring firewall addresses on FortiGate 2
1. Go to Policy & Objects > Addresses.
2. Create/Edit the subnets behind FortiGate 1 and FortiGate 2.
3. Create/Edit the primary and secondary interfaces of FortiGate 2.
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Configuring security policies on FortiGate 2
1. Go to Policy & Objects > IPv4 Policy.
2. Create the four security policies required for both FortiGate 2’s primary and secondary interfaces to connect to

FortiGate 1’s primary and secondary interfaces.

Results
1. Go toMonitor > IPsec Monitor to verify the statuses of both the primary and secondary IPsec VPN tunnels on

FortiGate 1 and FortiGate 2.
2. Go toMonitor > Routing Monitor. Monitor to verify the routing table on FortiGate 1 and FortiGate 2. Type

OSPF for the Type and select Apply Filter to verify the OSPF route.
3. Verify that traffic flows via the primary tunnel:

l From a PC1 set to IP:10.20.1.100 behind FortiGate 1, run a tracert to a PC2 set to IP address 10.21.1.00
behind FortiGate 2 and vise versa.

l From PC1, you should see that the traffic goes through 10.1.1.2 which is the primary tunnel interface IP set on
FortiGate 2.

l From PC2, you should see the traffic goes through 10.1.1.1 which is the primary tunnel interface IP set on
FortiGate 1.

4. The VPN network between the two OSPF networks uses the primary VPN connection. Disconnect the wan1
interface and confirm that the secondary tunnel will be used automatically to maintain a secure connection.

5. Verify the IPsec VPN tunnel statuses on FortiGate 1 and FortiGate 2. Both FortiGates should show that primary
tunnel is DOWN and secondary tunnel is UP.

6. Go toMonitor > IPsec Monitor to verify the status.
7. Verify the routing table on FortiGate 1 and FortiGate 2.

The secondary OSPF route (with cost = 100) appears on both FortiGate units.
8. Go toMonitor > Routing Monitor. TypeOSPF for the Type and select Apply Filter to verify OSPF route.
9. Verify that traffic flows via the secondary tunnel:

l From a PC1 set to IP:10.20.1.100 behind FortiGate 1, run a tracert to a PC2 set to IP:10.21.1.100 behind
FortiGate 2 and vice versa.

l From PC1, you should see that the traffic goes through 10.2.1.2 which is the secondary tunnel interface IP set
on FortiGate 2.

l From PC2, you should see the traffic goes through 10.2.1.1 which is the secondary tunnel interface IP set on
FortiGate 1.
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The following example shows how to create a dynamic IPsec VPN tunnel that allows OSPF.

Configuring IPsec on FortiGate 1
1. Go to Dashboard and enter the CLI Consolewidget
2. Create phase 1:

config vpn ipsec phase1-interface
edit "dial-up"

set type dynamic
set interface "wan1"
set mode-cfg enable
set proposal 3des-sha1
set add-route disable
set ipv4-start-ip 10.10.101.0
set ipv4-end-ip 10.10.101.255
set psksecret

next
end

3. Create phase 2:
config vpn ipsec phase2-interface

edit "dial-up-p2"
set phase1name "dial-up"
set proposal 3des-sha1 aes128-sha1

next
end

Configuring OSPF on FortiGate 1
1. Go to Dashboard and enter the CLI Consolewidget.
2. Create OSPF route.

config router ospf
set router-id 172.20.120.22

config area
edit 0.0.0.0
next

end
config network

edit 1
set prefix 10.10.101.0 255.255.255.0

next
end
config redistribute "connected"

set status enable
end
config redistribute "static"

set status enable
end

end
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Adding policies on FortiGate 1
1. Go to Policy & Objects > IPv4 Policy and create a policy allowing OSPF traffic from dial-up to port5.
2. Go to Policy & Objects > IPv4 Policy and create a policy allowing OSPF traffic from port5 to dial-up

interfaces.

Configuring IPsec on FortiGate 2
1. Go to Dashboard and enter the CLI Consolewidget
2. Create phase 1:

config vpn ipsec phase1-interface
edit "dial-up-client"

set interface "wan1"
set mode-cfg enable
set proposal 3des-sha1
set add-route disable
set remote-gw 172.20.120.22
set psksecret

next
end

3. Create phase 2:
config vpn ipsec phase2-interface

edit "dial-up-client"
set phase1name "dial-up-client"
set proposal 3des-sha1 aes128-sha1
set auto-negotiate enable

next
end

Configuring OSPF on FortiGate 2
1. Go to Dashboard and enter the CLI Consolewidget.
2. Create OSPF route.

config router ospf
set router-id 172.20.120.15

config area
edit 0.0.0.0
next

end
config network

edit 1
set prefix 10.10.101.0 255.255.255.0

next
end
config redistribute "connected"

set status enable
end
config redistribute "static"

set status enable
end

end
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Adding policies on FortiGate 2
1. Go to Policy & Objects > IPv4 Policy and create a policy allowing OSPF traffic from dial-up-client to port5.
2. Go to Policy & Objects > IPv4 Policy and create a policy allowing OSPF traffic from port5 to dial-up-client

interfaces.

Verifying the tunnel is up
Go toMonitor > IPsec Monitor to verify that the tunnel isUp.

Results
1. From FortiGate 1, go toMonitor > Routing Monitor and verify that routes from FortiGate 2 were successfully

advertised to FortiGate 1 via OSPF.
2. From FortiGate 1, go to Dashboard. Enter the CLI Console widget and type this command to verify OSPF

neighbors:
get router info ospf neighbor

OSPF process 0:
Neighbor ID Pri State Dead Time Address Interface
172.20.120.25 1  Full  / - 00:00:34 10.10.101.1  dial-up_0

3. From FortiGate 2, go toMonitor > Routing Monitor and verify that routes from FortiGate 1 were successfully
advertised to FortiGate 2 via OSPF.

4. From FortiGate 2, go to Dashboard. Enter the CLI Console widget and type this command to verify OSPF
neighbors:

get router info ospf neighbor

OSPF process 0:
Neighbor ID Pri State Dead Time Address Interface
172.20.120.22 1  Full  / - 00:00:30 10.10.101.2  dial-up_client
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The following example shows how to create a dynamic IPsec VPN tunnel that allows BGP.

Configuring IPsec on FortiGate 1

1. Go to Policy & Objects > Addresses and select create newAddress.

Name Remote_loop_int

Type Subnet

Subnet/IP Range 10.10.10.10

Interface any

2. Create an Address Group.

Group Name VPN_DST

Show in Address
List

enable

Members Remote_loop_int
all

3. Go to Dashboard and enter the CLI Console widget.
4. Create phase 1:

config vpn ipsec phase1-interface
edit Dialup

set type dynamic
set interface wan1
set mode aggressive
set peertype one
set mode-cfg enable
set proposal 3des-sha1 aes128-sha1
set peerid dial
set assign-ip disable
set psksecret

next
end

5. Create phase 2:
config vpn ipsec phase2-interface

edit dial_p2
set phase1name Dialup
set proposal 3des-sha1 aes128-sha1
set src-addr-type name
set dst-addr-type name
set src-name all
set dst-name VPN_DST
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next
end

Configuring BGP on FortiGate 1

1. Go to Network > Interfaces and create a Loopback interface.
2. Set IP/Network Mask to 20.20.20.20/255.255.255.255.
3. Go to Dashboard and enter the CLI Console widget.
4. Create a BGP route.

config router bgp
set as 100
set router-id 1.1.1.1

config neighbor
edit 10.10.10.10

set ebgp-enforce-multihop enable
set remote-as 200
set update-source loop

next
end
config redistribute connected

set status enable
end

end

Adding policies on FortiGate 1

1. Go to Policy & Objects > IPv4 Policy and create a policy allowing BGP traffic from Dialup to loop interfaces.
2. Go to Policy & Objects > IPv4 Policy and create a policy allowing BGP traffic from loop to Dialup interfaces.

Configuring IPsec on FortiGate 2

1. Go to Dashboard and enter the CLI Console widget.
2. Create phase 1:

config vpn ipsec phase1-interface
edit Dialup

set interface wan1
set mode aggressive
set mode-cfg enable
set proposal 3des-sha1 aes128-sha1
set localid dial
set remote-gw 172.20.120.22
set assign-ip disable
set psksecret

next
end

3. Create phase 2:
config vpn ipsec phase2-interface

edit dial_p2
set phase1name Dialup
set proposal 3des-sha1 aes128-sha1
set keepalive enable

next
end
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Configuring BGP on FortiGate 2

1. Go to Network > Interfaces and create a Loopback interface.
2. Set IP/Network Mask to 10.10.10.10/255.255.255.255.
3. Go to Dashboard and enter the CLI Consolewidget.
4. Create a BGP route.

config router bgp
set as 200
set router-id 1.1.1.2

config neighbor
edit 20.20.20.20

set ebgp-enforce-multihop enable
set remote-as 100
set update-source loop

next
end
config redistribute connected

set status enable
end

end

Adding policies on FortiGate 2

1. Go to Policy & Objects > IPv4 Policy and create a policy allowing BGP traffic from Dialup to loop interfaces.
2. Go to Policy & Objects > IPv4 Policy and create a policy allowing BGP traffic from loop to Dialup interfaces.

Adding a static route on FortiGate 2

Go to Network > Static Routes and add a route to the remote Loopback interface via Dialup interface.

Destination IP/Mask 20.20.20.20/255.255.255.255

Device Dialup

Administrative
Distance

10

Verifying the tunnel is up

Go toMonitor > IPsec Monitor to verify that the tunnel isUp.

Results

1. From FortiGate 1, go toMonitor > Routing Monitor and verify that routes from FortiGate 2 were successfully
advertised to FortiGate 1 via BGP.

2. From FortiGate 1, go to Dashboard.
3. Enter the CLI Consolewidget and type this command to verify BGP neighbors:

get router info bgp summary

4. From FortiGate 2, go toMonitor > Routing Monitor and verify that routes from FortiGate 1 were successfully
advertised to FortiGate 2 via BGP.
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5. From FortiGate 2, go to Dashboard.
6. Enter the CLI Consolewidget and type this command to verify BGP neighbors:

get router info bgp summary
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IPsec Auto-Discovery VPN (ADVPN)

Consider a company that wants to provide direct secure (IPsec) connections between all of its offices in New
York, Chicago, Greenwich, London, Paris, Frankfurt, Tokyo, Shanghai, and Hong Kong.

A straightforward solution is to create a full mesh of connections such that every site has eight IPsec
configurations, one for each of the other sites. If there were ninety sites, that could still be done but now the
configuration is becoming tedious, since every time a new site is added, N-1 other sites have to have their
configuration updated.

An efficient and secure alternative is IPsec Auto-Discovery VPN (ADVPN), which allows a minimum amount of
configuration per site but still allows direct IPsec connections to be made between every site. RFC 7018
essentially describes this problem, along with some requirements for candidate solutions.

The ADVPN solution involves partitioning the sites into spokes and hubs such that a spoke has to have enough
IPsec configuration to enable it to connect to at least one hub. A hub does not have specific configuration for each
spoke, so the amount of configuration does not grow with the number of spokes that are connected to that hub. A
hub to hub connection would typically involve both hubs having configuration for each other.

So, one possible partition for the original nine sites would be that Chicago and Greenwich would be spokes for the
New York hub, Paris and Frankfurt would be spokes for the London hub, and Tokyo and Hong Kong would be
spokes for the Shanghai hub:

Once a spoke has established a connection to its hub then initially IPsec traffic to another site transits via one or
more hubs. For example, traffic from Chicago to Hong Kong would transit via the New York and Shanghai hubs.
This transit traffic then triggers an attempt to create a more direct connection.

In FortiOS:
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l Direct connections are only created between the two endpoints that want to exchange traffic (e.g. Chicago and
Hong Kong); we do not create intermediate connections (say Chicago to Shanghai, or New York to Hong Kong) as a
side-effect.

l Learning the peer subnets is done via a dynamic routing protocol running over the IPsec connections.
l Negotiation of the direct connections is done via IKE.
l Both PSK and certificate authentication is supported.

Example ADVPN configuration
Since dynamic routing with IPsec under FortiOS requires that an interface have an IP address, then for every site
a unique IP address from some unused range is allocated. For example we'll assume that 10.100.0.0/16 is
unused and so assign the IP addresses:

l Chicago 10.100.0.4
l Greenwich 10.100.0.5
l New York 10.100.0.1

l London 10.100.0.2
l Shanghai 10.100.0.3
l Paris 10.100.0.6

l Frankfurt 10.100.0.7
l Hong Kong 10.100.0.8
l Tokyo 10.100.0.9

We'll assume that each site has one or more subnets that it protects that it wants to make available to the peers.
For the purposes of exposition we'll assume there is only one subnet per site and they are allocated as:

l Chicago 10.0.4.0/16
l Greenwich 10.0.5.0/24
l New York 10.0.1.0/24

l London 10.0.2.0/24
l Shanghai 10.0.3.0/24
l Paris 10.0.6.0/24

l Frankfurt 10.0.7.0/24
l Hong Kong 10.0.8.0/24
l Tokyo 10.0.9.0/24

Our example network topology now looks like this:
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The configuraton in Chicago would be as follows:

config vpn ipsec phase1-interface
edit "New York"

set type static
set interface wan1
set remote-gw <New-York-IP-address>
set psk <New-York-PSK>
set auto-discovery-receiver enable

next
end

The attribute auto-discovery-receiver indicates that this IPsec tunnel wishes to participate in an auto-
discovery VPN. The IPsec interface would then have its IP assigned according to the Chicago address:

config system interface
edit "New York"

set ip 10.100.0.4/32
set remote-ip 10.100.0.1

next
end

RIP (for simplicity, you could use OSPF or BGP) is then configured to run on the IPsec interface and on the
Chicago subnet (you could use redistribute connected, but we'll allow for the fact that there may be other subnets
learned from another router on the 10.0.4.0/24 subnet):

config router rip
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edit 1
set prefix 10.100.0.0/16

next
edit 2

set prefix 10.0.4.0/24
next

end

Other than the firewall policy and a minimal phase 2 configuration, this concludes the configuration for Chicago.

Each spoke would have a similar configuration.

The New York hub would have a dynamic phase 1 for its spoke connections, and two static phase 1s for its
connections to the other hubs:

config vpn ipsec phase1-interface
edit "Spokes"

set type dynamic
set interface wan1
set psk <New-York-PSK>
set auto-discovery-sender enable
set auto-discovery-psk enable
set add-route disable

next
edit "London"

set type static
set interface wan1
set psk <New-York-London-PSK>
set auto-discovery-forwarder enable

next
edit "Shanghai"

set type static
set interface wan1
set psk <New-York-Shanghai-PSK>
set auto-discovery-forwarder enable

next
end

The 'Spokes' connection has set auto-discovery-sender enable to indicate that when IPsec traffic
transits the hub it should optionally generate a message to the initiator of the traffic to indicate that it could
perhaps establish a more direct connection. The set add-route disable ensures that IKE does not
automatically add a route back over the spoke and instead leaves routing to a separately configured routing
protocol.

The two inter-hub connections have set auto-discovery-forwarder enable to indicate that these
connections can participate in the auto-discovery process. The interface IP addresses are assigned:

config system interface
edit "Spokes"

set ip 10.100.0.1/32
set remote-ip 10.100.0.254

next
edit "London"

set ip 10.100.0.1/32
set remote-ip 10.100.0.2

next
edit "London"

set ip 10.100.0.1/32
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set remote-ip 10.100.0.3
next

end

Following this, RIP is enabled on the relevant interfaces:

config router rip
edit 1

set prefix 10.100.0.0/16
next
edit 2

set prefix 10.0.1.0/24
next

end

A similar configuration would be used on the other two hubs.

Traffic flow and tunnel connection

With the configuration in place at all spokes and hubs, assuming all the spokes are connected to a hub, then
Chicago would learn (via RIP) that the route to the Hong Kong subnet 10.0.8.0/24 is via its "New York" interface.
If a device on the Chicago protected subnet (say 10.0.4.45) attempted to send traffic to the Hong Kong protected
subnet (say 10.0.8.13) then it should flow over the New York interface to New York, which should then transmit it
over the Shanghai tunnel to Shanghai, which should then send it over the dynamically negotiated Hong Kong
tunnel to Hong Kong.

At the point when the traffic transits New York it should notice that the Chicago Spoke tunnel and the Shanghai
tunnel have auto-discovery enabled, causing the New York hub to send a message via IKE to Chicago informing it
that it may want to try and negotiate a direct connection for traffic from 10.0.4.45 to 10.0.8.13.

On receipt of this message, IKE on Chicago creates the (FortiOS-specific) IKE INFORMATIONAL SHORTCUT-
QUERYmessage which contains the Chicago public IP address, the source IP of the traffic (10.0.4.45), the
desired destination IP (10.0.8.13), and the PSK that should be used to secure any direct tunnel (if certificates are
confgured, it is assumed that they all share the same CA and so no additional authentication information is
required). This message is sent via IKE to New York since routing indicates that New York is the best route to
10.0.8.13.

On receipt of the IKE INFORMATIONAL query, New York checks its routing table to see who owns 10.0.8.13. It
finds that 10.0.8.13 should be routed via Shanghai, and since Shanghai is marked as an auto-discovery-forwarder
then the query is forwarded.

Shanghai repeats the process, finds that 10.0.8.13 should be routed via its Hong Kong Spoke and so sends it to
Hong Kong. Hong Kong checks 10.0.8.13, finds that it owns the subnet, so it remembers the Chicago public IP
address (and PSK) and creates an IKE INFORMATIONAL reply message containing its external IP address. To
work out where to send the IKEmessage, the FortiGate does a routing lookup for the original source IP
(10.0.4.45), determines that the message should be routed via its Shanghai tunnel and so sends the reply back to
Shanghai. The reply then makes its way back to Chicago following the reverse of the path that it used to arrive at
Hong Kong.

When the reply makes it back to the Chicago initator then it now knows the IP address of the Hong Kong device.
Chicago now creates a new dynamic tunnel with the remote gateway as the Hong Kong public IP address and
initiates an IKE negotiation (the dynamic tunnel nameis auto-generated from the tunnel over which it performed
the query; in this case it would be called 'New York_0').

2211 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



IPsec Auto-Discovery VPN (ADVPN)

This negotiation should succeed since Hong Kong is set up to expect an attempted negotiation from the Chicago
public IP address. Once the negotiation succeeds, RIP will start to run on the newly created tunnels at Chicago
and Hong Kong. This will update the routing on Chicago (and Hong Kong) so that the prefered route to 10.0.8.0
(10.0.4.0) is via the newly created tunnel rather than via the connection to New York (Shanghai).

Notes about ADVPN in FortiOS

l Auto-discovery is only supported by IKEv1.
l All Spokes must have an IP address that is routable from any other spoke; devices behind NAT are not currently

supported.
l The feature requires the use of a dynamic routing protocol. There is no support for IKE handling routing.
l RIP is not a very scalable routing protocol. When there are more than a few spokes it would be advisable to use

route summarization to avoid huge RIP updates. Better yet, use BGP instead of RIP.
l It is assumed that spokes will not be used to transit other spoke traffic, for example: traffic from Chicago to Tokyo

would not transit an existing Chicago to Hong Kong tunnel even though that has a shorter hop count than a route via
New York and Shanghai.

l There is no facility to allow you to filter which traffic that transits the hub should trigger the message sent to the
initiator suggesting it create a direct connection. Currently any and all traffic will trigger it.
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Logging and monitoring

This section provides some general logging and monitoring procedures for VPNs.

The following topics are included in this section:

Monitoring VPN connections
You can use the monitor to view activity on IPsec VPN tunnels and to start or stop those tunnels. The display
provides a list of addresses, proxy IDs, and timeout information for all active tunnels.

Monitoring connections to remote peers

The list of tunnels provides information about VPN connections to remote peers that have static IP addresses or
domain names. You can use this list to view status and IP addressing information for each tunnel configuration.
You can also start and stop individual tunnels from the list.

To view the list of static-IP and dynamic-DNS tunnels go toMonitor > IPsec Monitor.

Monitoring dialup IPsec connections

The list of dialup tunnels provides information about the status of tunnels that have been established for dialup
clients. The list displays the IP addresses of dialup clients and the names of all active tunnels. The number of
tunnels shown in the list can change as dialup clients connect and disconnect.

To view the list of dialup tunnels go toMonitor > IPsec Monitor.

If you take down an active tunnel while a dialup client such as FortiClient is still connected, FortiClient will
continue to show the tunnel connected and idle. The dialup client must disconnect before another tunnel can be
initiated.

The list of dialup tunnels displays the following statistics:

l The Name column displays the name of the tunnel.
l The meaning of the value in the Remote gateway column changes, depending on the configuration of the network

at the far end:
l When a FortiClient dialup client establishes a tunnel, the Remote gateway column displays either the public IP

address and UDP port of the remote host device (on which the FortiClient Endpoint Security application is
installed), or if a NAT device exists in front of the remote host, the Remote gateway column displays the public
IP address and UDP port of the remote host.

l When a FortiGate dialup client establishes a tunnel, the Remote gateway column displays the public IP
address and UDP port of the FortiGate dialup client.

l The Username column displays the peer ID, certificate name, or XAuth user name of the dialup client (if a peer ID,
certificate name, or XAuth user name was assigned to the dialup client for authentication purposes).

l The Timeout column displays the time before the next key exchange. The time is calculated by subtracting the time
elapsed since the last key exchange from the keylife.

l The Proxy ID Source column displays the IP addresses of the hosts, servers, or private networks behind the
FortiGate unit. A network range may be displayed if the source address in the security encryption policy was
expressed as a range of IP addresses.
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l The meaning of the value in the Proxy ID Destination column changes, depending on the configuration of the
network at the far end:
l When a FortiClient dialup client establishes a tunnel:
l If VIP addresses are not used and the remote host connects to the Internet directly, the Proxy ID Destination

field displays the public IP address of the Network Interface Card (NIC) in the remote host.
l If VIP addresses are not used and the remote host is behind a NAT device, the Proxy ID Destination field

displays the private IP address of the NIC in the remote host.
l If VIP addresses were configured (manually or through FortiGate DHCP relay), the Proxy ID Destination field

displays either the VIP address belonging to a FortiClient dialup client, or a subnet address from which VIP
addresses were assigned.

l When a FortiGate dialup client establishes a tunnel, the Proxy ID Destination field displays the IP address of the
remote private network.

VPN event logs
You can configure the FortiGate unit to log VPN events. For IPsec VPNs, Phase 1 and Phase 2 authentication
and encryption events are logged. For information about how to interpret log messages, see the FortiGate Log
Message Reference.

Logging VPN events

1. Go to Log & Report > Log Settings.
2. Verify that the VPN activity event option is selected.
3. Select Apply.

Viewing event logs

1. Go to Log & Report > VPN Events.
2. Select the Log location.

Sending tunnel statistics to FortiAnalyzer

By default, logged events include tunnel-up and tunnel-down status events. Other events, by default, will appear
in the FortiAnalyzer report as "No Data Available". More accurate results require logs with action=tunnel-
stats, which is used in generating reports on the FortiAnalyzer (rather than the tunnel-up and tunnel-down
event logs). The FortiGate does not, by default, send tunnel-stats information.

To allow VPN tunnel-stats to be sent to FortiAnalyzer, configure the FortiGate unit as follows using the CLI:

config system settings
set vpn-stats-log ipsec ssl
set vpn-stats-period 300

end
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Troubleshooting

This section contains tips to help you with some common challenges of IPsec VPNs.

A VPN connection has multiple stages that can be confirmed to ensure the connection is working properly. It is
easiest to see if the final stage is successful first since if it is successful the other stages will be working properly.
Otherwise, you will need to work back through the stages to see where the problem is located.

When a VPN connection is properly established, traffic will flow from one end to the other as if both ends were
physically in the same place. If you can determine the connection is working properly then any problems are likely
problems with your applications.

On some FortiGate units, such as the FortiGate 94D, you cannot ping over the IPsec tunnel without first setting a
source-IP. In this scenario, you must assign an IP address to the virtual IPsec VPN interface. Anything sourced
from the FortiGate going over the VPN will use this IP address.

If the egress/outgoing interface (determined by kernel route) has an IP address, then use the IP address of the
egress/outgoing interface. Otherwise, use the IP address of the first interface from the interface list (that has an
IP address).

The first diagnostic command worth running, in any IPsec VPN troubleshooting situation, is the following:

diagnose vpn tunnel list

This command is very useful for gathering statistical data such as the number of packets encrypted versus
decrypted, the number of bytes sent versus received, the SPI identifier, etc. This kind of information in the
resulting output can make all the difference in determining the issue with the VPN.

Another appropriate diagnostic command worth trying is:

diagnose debug flow

This command will inform you of any lack of firewall policy, lack of forwarding route, and of policy ordering issues.

Common IPsec VPN problems
The most common IPsec VPN issues are listed below. Please read thoroughly and note that, although the list is
extensive, it is not exhaustive.

This section includes support for the following:

l Failed VPN connection attempts
l Debug output table
l The options to configure policy-based IPsec VPN are unavailable
l The VPN tunnel goes down frequently
l The pre-shared key does not match (PSK mismatch error)
l The SA proposals do not match (SA proposal mismatch)
l Pre-existing IPsec VPN tunnels need to be cleared
l Other potential VPN issues
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Failed VPN connection attempts

If your VPN fails to connect, check the following:

l Ensure that the pre-shared keysmatch exactly (see The pre-shared key does not match (PSK mismatch error)
below).

l Ensure that both ends use the same P1 and P2 proposal settings (seeThe SA proposals do not match (SA proposal
mismatch) below).

l Ensure that you have allowed inbound and outbound traffic for all necessary network services, especially if services
such as DNS or DHCP are having problems.

l Check that a static route has been configured properly to allow routing of VPN traffic.

If you are still unable to connect to the VPN tunnel, run the following diagnostic command in the CLI:

diagnose debug application ike -1
diagnose debug enable

The resulting output may indicate where the problem is occurring. When you are finished, disable the diagnostics
by using the following command:

diagnose debug reset
diagnose debug disable

View the table below for some assistance in analyzing the debug output.

Debug output table

Problem Debug output Common causes Common solutions

Tunnel is not
coming up

Error: negotiation failure IPsec configuration mismatch Check phase 1 and 2 settings

Error: no SA proposal
chosen

IPsec configuration mismatch Check phase 1 and 2 settings

FortiGate using the wrong
VPN

Missing or wrong local ID If there are more than one pre-
shared key dial-up VPN with the
same local gateway, use
aggressive mode and different
local IDs

Error: connection expiring
due to XAUTH failure

Wrong username, password,
or user group

Check user credentials and user
group configuration

Error: peer has not
completed XAUTH
exchange

XAuth is disabled in the client Fix the client's XAuth configuration

Tunnel is
bouncing

DPD packets lost ISP issue Check the ISP connection
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Problem Debug output Common causes Common solutions

Tunnel is up
but traffic
does not go
through

Error: No matching IPsec
selector, drop

Quick mode selector mismatch Fix the quick mode selector

NAT is enabled Disable NAT in the firewall policy

Traffic is not routed to the
tunnel

Route or firewall policy
misconfiguration

Route-based: traffic must be
routed to IPsec virtual interface
Policy-based: traffic must match a
firewall policy with action set to
IPSEC

The options to configure policy-based IPsec VPN are unavailable

Go to System > Feature Visibility. Select Show More and turn on Policy-based IPsec VPN.

The VPN tunnel goes down frequently

If your VPN tunnel goes down often, check the Phase 2 settings and either increase the Keylife value or enable
Autokey Keep Alive.

The pre-shared key does not match (PSK mismatch error)

It is possible to identify a PSK mismatch using the following combination of CLI commands:

diag vpn ike log filter name <phase1-name>
diag debug app ike -1
diag debug enable

This will provide you with clues as to any PSK or other proposal issues. If it is a PSK mismatch, you should see
something similar to the following output:

ike 0:TRX:322: PSK auth failed: probable pre-shared key mismatch
ike Negotiate SA Error:

The SA proposals do not match (SA proposal mismatch)

The most common problem with IPsec VPN tunnels is a mismatch between the proposals offered between each
party. Without a match and proposal agreement, Phase 1 can never establish. Use the following command to
show the proposals presented by both parties.

diag debug app ike -1
diag debug enable

The resulting output should include something similar to the following, where blue represents the remote VPN
device, and green represents the local FortiGate.

responder received SA_INIT msg
incoming proposal:
proposal id = 1:

protocol = IKEv2:
encapsulation = IKEv2/none

type=ENCR, val=AES_CBC (key_len = 256)
type=INTEGR, val=AUTH_HMAC_SHA_96
type=PRF, val=PRF_HMAC_SHA
type=DH_GROUP, val=1536.
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proposal id = 2:
protocol = IKEv2:

encapsulation = IKEv2/none
type=ENCR, val=3DES_CBC
type=INTEGR, val=AUTH_HMAC_SHA_2_256_128
type=PRF, val=PRF_HMAC_SHA2_256
type=DH_GROUP, val=1536.

proposal id = 1:
protocol = IKEv2:

encapsulation = IKEv2/none
type=ENCR, val=AES_CBC (key_len = 128)
type=INTEGR, val=AUTH_HMAC_SHA_96
type=PRF, val=PRF_HMAC_SHA
type=DH_GROUP, val=1536.

Pre-existing IPsec VPN tunnels need to be cleared

Should you need to clear an IKE gateway, use the following commands:

diagnose vpn ike restart
diagnose vpn ike gateway clear

Other potential VPN issues

l Ensure that your FortiGate unit is in NAT mode, rather than Transparent.
l Check your NAT settings, enabling NAT traversal in the Phase 1 configuration while disabling NAT in the security

policy. You might need to pin the PAT/NAT session table, or use some of kind of NAT-T keepalive to avoid the
expiration of your PAT/NAT translation.

l Ensure that both ends of the VPN tunnel are using Main mode, unless multiple dial-up tunnels are being used.
l Remove any Phase 1 or Phase 2 configurations that are not in use. If a duplicate instance of the VPN tunnel

appears on the IPsec Monitor, reboot your FortiGate unit to try and clear the entry.
l If you have multiple dial-up IPsec VPNs, ensure that the peer ID is configured properly on the FortiGate and that

clients have specified the correct local ID. Furthermore, in circumstances where multiple remote dialup VPN tunnels
exist, each tunnel must have a peer ID set.

l If you are using FortiClient, ensure that your version is compatible with the FortiGate firmware by reading the
FortiOS Release Notes.

l If you are using Perfect Forward Secrecy (PFS), ensure that it is used on both peers. You can use the diagnose
vpn tunnel list command to troubleshoot this.

l Ensure that theQuick Mode selectors are correctly configured. If part of the setup currently uses firewall
addresses or address groups, try changing it to either specify the IP addresses or use an expanded address range.
This is especially useful if the remote endpoint is not a FortiGate device.

l If XAUTH is enabled, ensure that the settings are the same for both ends, and that the FortiGate unit is set to
Enable as Server.

l Check IPsec VPN Maximum Transmission Unit (MTU) size. A 1500 byte MTU is going to exceed the overhead of
the ESP-header, including the additional ip_header,etc. You can use the diagnose vpn tunnel list
command to troubleshoot this.

l If your FortiGate unit is behind a NAT device, such as a router, configure port forwarding for UDP ports 500 and
4500.
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Troubleshooting connection issues
The following section includes troubleshooting suggestions related to:

l LAN interface connection
l Dialup connection
l Troubleshooting VPN connections
l Troubleshooting invalid ESP packets using Wireshark
l Attempting hardware offloading beyond SHA1
l Check Phase 1 proposal settings
l Check your routing
l Try enabling XAuth

LAN interface connection

To confirm whether a VPN connection over LAN interfaces has been configured correctly, issue a ping or
traceroute command on the network behind the FortiGate unit to test the connection to a computer on the remote
network. If the connection is properly configured, a VPN tunnel will be established automatically when the first
data packet destined for the remote network is intercepted by the FortiGate unit.

If the ping or traceroute fail, it indicates a connection problem between the two ends of the tunnel. This may or
may not indicate problems with the VPN tunnel. You can confirm this by going toMonitor > IPsec Monitor
where you will be able to see your connection. A green arrow means the tunnel is up and currently processing
traffic. A red arrow means the tunnel is not processing traffic, and this VPN connection has a problem.

If the connection has problems, see Troubleshooting VPN connections on page 2219.

Dialup connection

A dialup VPN connection has additional steps. To confirm that a VPN between a local network and a dialup client
has been configured correctly, at the dialup client, issue a ping command to test the connection to the local
network. The VPN tunnel initializes when the dialup client attempts to connect.

If the ping or traceroute fail, it indicates a connection problem between the two ends of the tunnel. This may or
may not indicate problems with the VPN tunnel, or dialup client. As with the LAN connection, confirm the VPN
tunnel is established by checkingMonitor > IPsec Monitor.

Troubleshooting VPN connections

If you have determined that your VPN connection is not working properly through Troubleshooting on page 2215,
the next step is to verify that you have a phase2 connection.

If traffic is not passing through the FortiGate unit as you expect, ensure the traffic does not contain IPcomp
packets (IP protocol 108, RFC 3173). FortiGate units do not allow IPcomp packets, they compress packet
payload, preventing it from being scanned.

Testing Phase 1 and 2 connections is a bit more difficult than testing the working VPN. This is because they
require diagnose CLI commands. These commands are typically used by Fortinet customer support to discover
more information about your FortiGate unit and its current configuration.

Before you begin troubleshooting, you must:
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l Configure FortiGate units on both ends for interface VPN
l Record the information in your VPN Phase 1 and Phase 2 configurations - for our example here the remote IP

address is 10.11.101.10 and the names of the phases are Phase 1 and Phase 2
l Install a telnet or SSH client such as putty that allows logging of output
l Ensure that the admin interface supports your chosen connection protocol so you can connect to your FortiGate unit

admin interface.

For this example, default values were used unless stated otherwise.

Obtaining diagnose information for the VPN connection - CLI

1. Log into the CLI as admin with the output being logged to a file.
2. Stop any diagnose debug sessions that are currently running with the CLI command

diagnose debug disable

3. Clear any existing log-filters by running
diagnose vpn ike log-filter clear

4. Set the log-filter to the IP address of the remote computer (10.11.101.10). This filters out all VPN connections
except ones to the IP address we are concerned with. The command is

diagnose vpn ike log-filter dst-addr4 10.11.101.10.

5. Set up the commands to output the VPN handshaking. The commands are:
diagnose debug app ike 255
diagnose debug enable

6. Have the remote FortiGate initiate the VPN connection in the web-based manager by going to
VPN > IPsec Tunnels and selecting Bring up.

This makes the remote FortiGate the initiator and the local FortiGate becomes the responder. Establishing the
connection in this manner means the local FortiGate will have its configuration information as well as the
information the remote computer sends. Having both sets of information locally makes it easier to troubleshoot
your VPN connection.

7. Watch the screen for output, and after roughly 15 seconds enter the following CLI command to stop the output.
diagnose debug disable

8. If needed, save the log file of this output to a file on your local computer. Saving the output to a file can make it
easier to search for a particular phrase, and is useful for comparisons.

Troubleshooting a Phase 1 VPN connection

Using the output from Obtaining diagnose information for the VPN connection - CLI, search for the word
proposal in the output. It may occur once indicating a successful connection, or it will occur two or more times
for an unsuccessful connection — there will be one proposal listed for each end of the tunnel and each possible
combination in their settings. For example if 10.11.101.10 selected both Diffie-Hellman Groups 1 and 5, that
would be at least 2 proposals set.

A successful negotiation proposal will look similar to

IPsec SA connect 26 10.12.101.10->10.11.101.10:500
config found
created connection: 0x2f55860 26 10.12.101.10->10.11.101.10:500
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IPsec SA connect 26 10.12.101.10->10.11.101.10:500 negotiating
no suitable ISAKMP SA, queuing quick-mode request and initiating ISAKMP SA negotiation
initiator: main mode is sending 1st message...
cookie 3db6afe559e3df0f/0000000000000000
out [encryption]
sent IKE msg (ident-i1send): 10.12.101.10:500->10.11.101.10:500, len=264,

id=3db6afe559e3df0f/0000000000000000
diaike 0: comes 10.12.101.1:500->10.11.101.1:500,ifindex=26....

Note the phrase “initiator: main mode is sending 1st message...” which shows you the
handshake between the ends of the tunnel is in progress. Initiator shows the remote unit is sending the first
message.

Troubleshooting invalid ESP packets using Wireshark

The following section provides information to help debug an encryption key mismatch. The ESP packet invalid
error is due to an encryption key mismatch after a VPN tunnel has been established. When an IPsec VPN tunnel
is up, but traffic is not able to pass through the tunnel, Wireshark (or an equivalent program) can be used to
determine whether there is an encryption mismatch. Amismatch could occur for many reasons, one of the most
common is the instability of an ISP link (ADSL, Cable), or it could effectively be any device in the physical
connection.

The following information is required to troubleshoot the problem.

l Take a packet sniffer trace on both FortiGates.
l Run the diag vpn tunnel list command a few times on both FortiGates when generating traffic that will

pass through the tunnel.

In the following example, the error message was seen on the recipient FortiGate:

date=2010-12-28 time=18:19:35 devname=Kosad_VPN device_id=FG300B3910600118 log_
id=0101037132 type=event subtype=ipsec pri=critical vd="root" msg="IPsec ESP" action="error" rem_
ip=180.87.33.2 loc_ip=121.133.8.18 rem_port=32528 loc_port=4500 out_intf="port2"
cookies="88d40f65d555ccaf/05464e20e4afc835" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="fortinet_0" status=esp_error error_num=Invalid ESP packet detected (HMAC
validation failed). spi=c32b09f7 seq=00000012

This is the output of the command diag vpn tunnel list on the FortiGate:

inet ver=1 serial=2 192.168.1.205:4500->121.133.8.18:4500 lgwy=dyn tun=intf mode=auto bound_if=4
proxyid_num=1 child_num=0 refcnt=7 ilast=0 olast=0
stat: rxp=41 txp=56 rxb=4920 txb=3360
dpd: mode=active on=1 idle=5000ms retry=3 count=0 seqno=696
natt: mode=keepalive draft=32 interval=10 remote_port=4500
proxyid=P2_60C_Fortinet proto=0 sa=1 ref=2 auto_negotiate=0 serial=1 src:
0:182.40.101.0/255.255.255.0:0
dst: 0:100.100.100.0/255.255.255.0:0
SA: ref=3 options=0000000d type=00 soft=0 mtu=1428 expire=1106 replaywin=0 seqno=15
life: type=01 bytes=0/0 timeout=1777/1800
dec: spi=29a26eb6 esp=3des key=24 bf25e69df90257f64c55dda4069f01834cd0382fe4866ff2
ah=sha1 key=20 38b2600170585d2dfa646caed5bc86d920aed7ff
enc: spi=c32b09f7 esp=3des key=24 0abd3c70032123c3369a6f225a385d30f0b2fb1cd9687ec8
ah=sha1 key=20 214d8e717306dffceec3760464b6e8edb436c6

This is the packet capture from the FortiGate:
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How to verify if the original packet has been encrypted correctly

To verify, it is necessary to decrypt the ESP packet using Wireshark. Open the packet capture that is taken from
initiator FortiGate using Wireshark. Go to Edit > Preferences, expand Protocol and look for ESP. Select
"Attempt to detect/decode encrypted ESP payloads", and fill in the information for the encryption algorithm
and the keys. This information can be obtained from the output of the command diag vpn tunnel list.

If the packet was encrypted correctly using the correct key, then the decryption will be successful and it will be
possible to see the original package as shown below:

Repeat the decryption process for the packet capture from the recipient firewall. If the decryption failed using the
same key, the packet may be corrupted and the interface should then be checked for CRC or packet errors.

Attempting hardware offloading beyond SHA1

If you are trying to off-load VPN processing to a network processing unit (NPU), remember that only SHA1
authentication is supported. For high levels of authentication such as SHA256, SHA384, and SHA512 hardware
offloading is not an option—all VPN processing must be done in software—unless using an NP6 (although the
NP4lite variation also supports SHA256, SHA384, and SHA512).

Enable/disable IPsec ASIC-offloading

Much like NPU-offload in IKE phase1 configuration, you can enable or disable the usage of ASIC hardware for
IPsec Diffie-Hellman key exchange and IPsec ESP traffic. By default hardware offloading is used. For debugging
purposes, sometimes it is best for all the traffic to be processed by software.

config sys global
set ipsec-asic-offload [enable | disable]

end

Check Phase 1 proposal settings

Ensure that both sides have at least one Phase 1 proposal in common. Otherwise they will not connect. If there
are many proposals in the list, this will slow down the negotiating of Phase 1. If its too slow, the connection may
timeout before completing. If this happens, try removing some of the unused proposals.

NPU offloading is supported when the local gateway is a loopback interface.
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Check your routing

If routing is not properly configured with an entry for the remote end of the VPN tunnel, traffic will not flow
properly. You may need static routes on both ends of the tunnel. If routing is the problem, the proposal will likely
setup properly but no traffic will flow.

Try enabling XAuth

If one end of an attempted VPN tunnel is using XAuth and the other end is not, the connection attempt will fail.
The log messages for the attempted connection will not mention XAuth is the reason, but when connections are
failing it is a good idea to ensure both ends have the same XAuth settings. If you do not know the other end’s
settings enable or disable XAuth on your end to see if that is the problem.

General troubleshooting tips
Most connection failures are due to a configuration mismatch between the FortiGate unit and the remote peer. In
general, begin troubleshooting an IPsec VPN connection failure as follows:

1. Ping the remote network or client to verify whether the connection is up. See General troubleshooting tips on page
2223.

2. Traceroute the remote network or client. If DNS is working, you can use domain names. Otherwise use IP
addresses.

3. Check the routing behind the dialup client. Routing problemsmay be affecting DHCP. If this appears to be the
case, configure a DHCP relay service to enable DHCP requests to be relayed to a DHCP server on or behind the
FortiGate server.

4. Verify the configuration of the FortiGate unit and the remote peer. Check the following IPsec parameters:
l The mode setting for ID protection (main or aggressive) on both VPN peers must be identical.
l The authentication method (preshared keys or certificates) used by the client must be supported on the

FortiGate unit and configured properly.
l If preshared keys are being used for authentication purposes, both VPN peers must have identical preshared

keys.
l The remote client must have at least one set of Phase 1 encryption, authentication, and Diffie-Hellman settings

that match corresponding settings on the FortiGate unit.
l Both VPN peers must have the same NAT traversal setting (enabled or disabled).
l The remote client must have at least one set of Phase 2 encryption and authentication algorithm settings that

match the corresponding settings on the FortiGate unit.
l If you are using manual keys to establish a tunnel, the Remote SPI setting on the FortiGate unit must be

identical to the Local SPI setting on the remote peer, and vise versa.

5. To correct the problem, see the following table.

VPN troubleshooting tips

Configuration problem Correction

Mode settings do not
match.

Select complementary mode settings. See Phase 1 parameters on page
2048.
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Configuration problem Correction

Peer ID or certificate name
of the remote peer or
dialup client is not
recognized by FortiGate
VPN server.

Check Phase 1 configuration. Depending on the Remote Gateway and
Authentication Method settings, you have a choice of options to
authenticate FortiGate dialup clients or VPN peers by ID or certificate
name (see Phase 1 parameters on page 2048).

If you are configuring authentication parameters for FortiClient dialup
clients, refer to the Authenticating FortiClient Dialup Clients Technical
Note.

Preshared keys do not
match.

Reenter the preshared key. See Phase 1 parameters on page 2048.

Phase 1 or Phase 2 key
exchange proposals are
mismatched.

Make sure that both VPN peers have at least one set of proposals in
common for each phase. See Phase 1 parameters on page 2048 and
Phase 2 parameters on page 2067.

NAT traversal settings are
mismatched.

Select or clear both options as required. See Phase 1 parameters on page
2048 and Phase 1 parameters on page 2048.

A word about NAT devices

When a device with NAT capabilities is located between two VPN peers or a VPN peer and a dialup client, that
device must be NAT traversal (NAT-T) compatible for encrypted traffic to pass through the NAT device. For more
information, see Phase 1 parameters on page 2048.

Troubleshooting L2TP and IPsec
This section describes some checks and tools you can use to resolve issues with L2TP-over-IPsec VPNs.

This section includes:

l Quick checks
l Mac OS X and L2TP
l Setting up logging
l Using the FortiGate unit debug commands

Quick checks

The table below is a list of common L2TP over IPsec VPN problems and the possible solutions.
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Problem What to check

IPsec tunnel does not come
up.

Check the logs to determine whether the failure is in Phase 1 or Phase 2.

Check the settings, including encapsulation setting, which must be
transport-mode.

Check the user password.

Confirm that the user is a member of the user group assigned to L2TP.

On the Windows PC, check that the IPsec service is running and has not
been disabled. See Troubleshooting L2TP and IPsec on page 2224.

Tunnel connects, but there
is no
communication.

Did you create an ACCEPT security policy from the public network to the
protected network for the L2TP clients? See Troubleshooting L2TP and
IPsec on page 2224.

Mac OS X and L2TP

FortiOS allows L2TP connections with empty AVP host names and therefore Mac OS X L2TP connections can
connect to the FortiGate.

Prior to FortiOS 4.0 MR3, FortiOS refused L2TP connections with empty AVP host names in compliance with
RFC 2661 and RFC 3931.

Setting up logging

L2TP logging must be enabled to record L2TP events. Alert email can be configured to report L2TP errors.

Configuring FortiGate logging for L2TP over IPsec

1. Go to Log & Report > Log Settings.
2. Select Event Log.
3. Select the VPN activity event check box.
4. Select Apply.

Viewing FortiGate logs

1. Go to Log & Report > VPN Events.
2. Select the Log location if required.
3. After each attempt to start the L2TP over IPsec VPN, select Refresh to view logged events.

Using the FortiGate unit debug commands

Viewing debug output for IKE and L2TP

1. Start an SSH or Telnet session to your FortiGate unit.
2. Enter the following CLI commands

diagnose debug application ike -1
diagnose debug application l2tp -1
diagnose debug enable
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3. Attempt to use the VPN and note the debug output in the SSH or Telnet session.
4. Enter the following command to reset debug settings to default:

diagnose debug reset

Using the packet sniffer

1. Start an SSH or Telnet session to your FortiGate unit.
2. Enter the following CLI command

diagnose sniffer packet any icmp 4

3. Attempt to use the VPN and note the debug output.
4. Enter Ctrl-C to end sniffer operation.

Typical L2TP over IPsec session startup log entries - raw format

2010-01-11 16:39:58 log_id=0101037127 type=event subtype=ipsec pri=notice vd="root" msg="progress IPsec
Phase 1" action="negotiate" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="dialup_p1" status=success init=remote mode=main dir=outbound stage=1
role=responder result=OK

2010-01-11 16:39:58 log_id=0101037127 type=event subtype=ipsec pri=notice vd="root" msg="progress IPsec
Phase 1" action="negotiate" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="dialup_p1" status=success init=remote mode=main dir=outbound stage=2
role=responder result=OK

2010-01-11 16:39:58 log_id=0101037127 type=event subtype=ipsec pri=notice vd="root" msg="progress IPsec
Phase 1" action="negotiate" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="dialup_p1" status=success init=remote mode=main dir=inbound stage=3
role=responder result=DONE

2010-01-11 16:39:58 log_id=0101037127 type=event subtype=ipsec pri=notice vd="root" msg="progress IPsec
Phase 1" action="negotiate" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="dialup_p1_0" status=success init=remote mode=main dir=outbound stage=3
role=responder result=DONE

2010-01-11 16:39:58 log_id=0101037129 type=event subtype=ipsec pri=notice vd="root" msg="progress IPsec
Phase 2" action="negotiate" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="dialup_p1_0" status=success init=remote mode=quick dir=outbound stage=1
role=responder result=OK

2010-01-11 16:39:58 log_id=0101037133 type=event subtype=ipsec pri=notice vd="root" msg="install IPsec
SA" action="install_sa" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="dialup_p1_0" role=responder in_spi=61100fe2 out_spi=bd70fca1

2010-01-11 16:39:58 log_id=0101037139 type=event subtype=ipsec pri=notice vd="root" msg="IPsec Phase 2
status change" action="phase2-up" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500
out_intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A"
xauth_group="N/A" vpn_tunnel="dialup_p1_0" phase2_name=dialup_p2

2010-01-11 16:39:58 log_id=0101037138 type=event subtype=ipsec pri=notice vd="root" msg="IPsec
connection status change" action="tunnel-up" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500
loc_port=500 out_intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_
user="N/A" xauth_group="N/A" vpn_tunnel="dialup_p1_0" tunnel_ip=172.20.120.151 tunnel_id=1552003005
tunnel_type=ipsec duration=0 sent=0 rcvd=0 next_stat=0 tunnel=dialup_p1_0

2010-01-11 16:39:58 log_id=0101037129 type=event subtype=ipsec pri=notice vd="root" msg="progress IPsec
Phase 2" action="negotiate" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
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group="N/A" vpn_tunnel="dialup_p1_0" status=success init=remote mode=quick dir=inbound stage=2
role=responder result=DONE

2010-01-11 16:39:58 log_id=0101037122 type=event subtype=ipsec pri=notice vd="root" msg="negotiate IPsec
Phase 2" action="negotiate" rem_ip=172.20.120.151 loc_ip=172.20.120.141 rem_port=500 loc_port=500 out_
intf="port1" cookies="5f6da1c0e4bbf680/d6a1009eb1dde780" user="N/A" group="N/A" xauth_user="N/A" xauth_
group="N/A" vpn_tunnel="dialup_p1_0" status=success role=responder esp_transform=ESP_3DES esp_auth=HMAC_
SHA1

2010-01-11 16:39:58 log_id=0103031008 type=event subtype=ppp vd=root pri=information action=connect
status=success msg="Client 172.20.120.151 control connection started (id 805), assigned ip 192.168.0.50"

2010-01-11 16:39:58 log_id=0103029013 type=event subtype=ppp vd=root pri=notice pppd is started

2010-01-11 16:39:58 log_id=0103029002 type=event subtype=ppp vd=root pri=notice user="user1"
local=172.20.120.141 remote=172.20.120.151 assigned=192.168.0.50 action=auth_success msg="User 'user1'
using l2tp with authentication protocol MSCHAP_V2, succeeded"

2010-01-11 16:39:58 log_id=0103031101 type=event subtype=ppp vd=root pri=information action=tunnel-up
tunnel_id=1645784497 tunnel_type=l2tp remote_ip=172.20.120.151 tunnel_ip=192.168.0.50 user="user1"
group="L2TPusers" msg="L2TP tunnel established"

Troubleshooting GRE over IPsec
This section describes some checks and tools you can use to resolve issues with the GRE-over-IPsec VPN.

Quick checks

Here is a list of common problems and what to verify.

Problem What to check

No communication with
remote
network.

Use the execute ping command to ping the Cisco device public interface.

Use the FortiGate VPNMonitor page to see whether the IPsec tunnel is up or
can be brought up.

IPsec tunnel does not
come up.

Check the logs to determine whether the failure is in Phase 1 or Phase 2.

Check that the encryption and authentication settings match those on the
Cisco device.

Check the encapsulation setting: tunnel-mode or transport-mode. Both devices
must use the same mode.

Tunnel connects, but
there is no
communication.

Check the security policies. See Troubleshooting GRE over IPsec on page
2227.

Check routing. See Troubleshooting GRE over IPsec on page 2227.

Setting up logging

Configuring FortiGate logging for IPsec

1. Go to Log & Report > Log Settings.
2. Select the Event Logging.
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3. Select VPN activity event.
4. Select Apply.

Viewing FortiGate logs

1. Go to Log & Report > VPN Events.
2. Select the log storage type.
3. Select Refresh to view any logged events.

GRE tunnel keepalives

In the event that each GRE tunnel endpoint has keepalive enabled, firewall policies allowing GRE are required in
both directions. The policy should be configured as follows (where the IP addresses and interface names are for
example purposes only):

config firewall policy
edit < id >

set srcintf "gre"
set dstintf "port1"
set srcaddr "1.1.1.1"
set dstaddr "2.2.2.2"
set action accept
set schedule "always"
set service "GRE"

next
end

Cisco compatible keep-alive support for GRE

The FortiGate can send a GRE keepalive response to a Cisco device to detect a GRE tunnel. If it fails, it will
remove any routes over the GRE interface.

Configuring keepalive query - CLI:

config system gre-tunnel
edit <id>

set keepalive-interval <value: 0-32767>
set keepalive-failtimes <value: 1-255>

next
end

GRE tunnel with multicast traffic

If you want multicast traffic to traverse the GRE tunnel, you need to configure a multicast policy as well as enable
multicast forwarding.

l To configure a multicast policy, use the config firewall multicast-policy command.
l To enable multicast forwarding, use the following commands:

config system settings
set multicast-forward enable

end
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Using diagnostic commands

There are some diagnostic commands that can provide useful information. When using diagnostic commands, it
is best practice that you connect to the CLI using a terminal program, such as puTTY, that allows you to save
output to a file. This will allow you to review the data later on at your own speed without worry about missed data
as the diag output scrolls by.

Using the packet sniffer - CLI:

1. Enter the following CLI command:
diag sniff packet any icmp 4

2. Ping an address on the network behind the FortiGate unit from the network behind the Cisco router.

The output will show packets coming in from the GRE interface going out of the interface that connects to the
protected network (LAN) and vice versa. For example:

114.124303 gre1 in 10.0.1.2 -> 10.11.101.10: icmp: echo request
114.124367 port2 out 10.0.1.2 -> 10.11.101.10: icmp: echo request
114.124466 port2 in 10.11.101.10 -> 10.0.1.2: icmp: echo reply
114.124476 gre1 out 10.11.101.10 -> 10.0.1.2: icmp: echo reply

3. Enter CTRL-C to stop the sniffer.

Viewing debug output for IKE - CLI:

1. Enter the following CLI commands
diagnose debug application ike -1
diagnose debug enable

2. Attempt to use the VPN or set up the VPN tunnel and note the debug output.
3. Enter CTRL-C to stop the debug output.
4. Enter the following command to reset debug settings to default:

diagnose debug reset
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IPv6

The origins of Internet Protocol Version 6 (IPv6) date back to December 1998 with the publication of RFC 2460,
which describes IPv6 as the successor to IPv4, the standard communications protocol still in use by the majority
of users today. This transition away from IPv4 was a direct response to the foreseeable exhaustion of 32-bit IPv4
addresses, which are virtually all but assigned—all 4.3 billion.

IPv4 uses 32-bit addresses, which means that there is a theoretical address limit of 2 to the power of 32. The IPv6
address scheme is based on a 128-bit address, resulting in a theoretical address limit of 2 to the power of 128.

Possible addresses:

IPv4 = Roughly 4.3 billion

IPv6 = Over 340 undecillion (340 followed by 36 digits)

Assuming a world population of approximately 8 billion people, IPv6 would allow for each individual to have
approximately 42,535,295,865,117,200,000,
000,000,000 devices with an IP address. That’s 42 quintillion devices, so it’s unlikely that we will ever need to
worry about the availability of IPv6 addresses.

Aside from the difference of possible addresses, there is also the different formatting of the addresses. A
computer would view an IPv4 address as a 32-bit string of binary digits made up of 1s and 0s, broken up into 4
octets of 8 digits separated by a period:

10101100.00010000.11111110.00000001

To make the number more user-friendly, we translate the address into decimal, again 4 octets separated by a
period:

172.16.254.1

A computer would view an IPv6 address as a 128-bit string of binary digits made up of 1s and 0s, broken up into 8
octets of 16 digits separated by a colon:

0010000000000001:0000110110111:0000000000000000:000000000000010:0000000000000000:000000000
0000000:0000000000000000:0000000000100000

To make this number a little more user-friendly, we translate it into hexadecimal, again 8 octets separated by a
colon, for example:

2001:0db8:0000:0002:0000:0000:0000:0020

We can further simplify the above address. Because any four-digit group of zeros within an IPv6 address may be
reduced to a single zero or altogether omitted, the above address can be reduced to:

2001:0db8:0000:0002:0:0:0:20

or
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2001:db8:0:2::20

IPv6 packet structure
Each IPv6 packet consists of a mandatory fixed header and optional extension headers, and carries a payload,
which is typically either a datagram and/or Transport Layer information. The payload could also contain data for
the Internet Layer or Link Layer. Unlike IPv4, IPv6 packets aren't fragmented by routers, requiring hosts to
implement Maximum Transmission Unit (MTU) Path Discovery for MTUs larger than the smallest MTU (which is
1280 octets).

Jumbograms and jumbo payloads

In IPv6, packets which exceed the MTU of the underlying network are labelled jumbograms, which consist of a
jumbo payload. A jumbogram typically exceeds the IPMTU size limit of 65,535 octets, and provides the jumbo
payload option, which can allow up to nearly 4GiB of payload data, as defined in RFC 2675. When the MTU is
determined to be too large, the receiving host sends a 'Packet too Big' ICMPv6 type 2 message to the sender.

Fragmentation and reassembly

As noted, packets that are too large for the MTU require hosts to perform MTU Path Discovery to determine the
maximum size of packets to send. Packets that are too large require a 'Fragment' extension header, to divide the
payload into segments that are 8 octets in length (except for the last fragment, which is smaller). Packets are
reassembled according to the extension header and the fragment offset.

Benefits of IPv6
Some of the benefits of IPv6 include:

l More efficient routing
l Reduced management requirement
l Stateless auto-reconfiguration of hosts
l Improved methods to change Internet Service Providers
l Better mobility support
l Multi-homing
l Security
l Scoped address: link-local, site-local, and global address space

What's new for IPv6 in FortiOS 5.6

IPv6 (5.6.3)
New IPv6 features added to FortiOS 5.6.3:

IPv6 RADIUS support (402437, 439773)

Added support for IPv6 RADIUS authentication. When configuring the FortiGate interface and the RADIUS server
(under config system interface and config user radius respectively), the server IP address can
be set as IPv6.
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Added support for IPv6 Fortisandbox (424290) (447153)

FortiOS can now communicate with a FortiSandbox if the FortiSandbox has an IPv6 IP address.

IPv6 captive portal support (435435)

Captive portal now supports IPv6 addresses; works with remote RADIUS authentication and WiFi interfaces.

FortiGate can reply to an anycast probe from the interface’s unicast address (308872)

A new setting has been added within the CLI that can enable the FortiGate to reply to an anycast probe from the
FortiGate’s unicast IP address.

config system global
set ipv6-allow-anycast-probe [enable|disable]
end

Enable: Enable probing of IPv6 address space through Anycast, by responding from the unicast IP address

Disable:Disable probing of IPv6 address space through Anycast

Secure Neighbor Discovery (355946)

Additional settings have been added to the configuration for interfaces with IPv6 so that they comply more closely
to the parameters of RFC 3971

The context of the new settings is

config system interface
edit <interface>
config ipv6

The new options with IPv6 are:

ndmode

Neighbor discovery mode

set ndmode [basic | SEND]

Basic: Does not support SEND.

SEND-compatible: Supports SEND.

nd-cert

Neighbor discovery certificate

set nd-cert <string of Name of certificate to be used>

Example string: "Fortinet_Factory local"

n-security-level

Neighbor discovery security level

set nd-security-level <integer>
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l Integer values from 0 - 7
l 0 = least secure
l 7 =most secure
l default = 0

nd-timestamp-delta -

Neighbor discovery timestamp delta value

set nd-timestamp-delta <integer of time in seconds>

l Range: 1 - 3600 sec
l default = 300

nd-timestamp-fuzz

Neighbor discovery timestamp fuzz factor

set nd-timestamp-fuzz <integer of time in seconds>

l Range: 1 - 60 sec
l default = 1

Additional related technical information

Kerenl

l Redirects ICMPv6 packets to user space if they require SEND options verification or build.

Radvd

l Verifies NS/RS SEND options including CGA, RSA, Timestamp, NONCE, etc. Daemon also creates neighbor cache
for future timestamp checking, any entry gets flushed in 4 hours.

l Helps kernel build NA/RA SEND options including CGA, RSA, Timestamp, NONCE, etc. CGA parameters are kept
in cache for each interface. CGAmodifier is kept in CMDB.

Diagnose command for radvd

diag test application radvd

l Shows statistics
l Toggles message dump

Add multicast-PMTU to allow FGT to send ICMPv6 Too Big Message (373396)

Newmulticast-PMTU feature added to better comply with RFC 4443.

Normally, a “Packet Too Big” icmp6 message is sent by a routing device in response to a packet that it cannot
forward because the packet is larger than the MTU of the outgoing link. For security reasons, these message may
be disabled because attackers can use the information about a victim's ip address as the source address to do IP
address spoofing.
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In FortiOS’s implementation of this function, a setting in the CLI, has been added to make this behavior optional
on the FortiGate.

The syntax for the option is:

config router multicast6
set multicast-PMTU [enable|disable]
end
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IPv6 Features

In order to configure IPv6 features using the web-based manager, IPv6 must be enabled using Feature Select.
Go to System > Config > Features, enable IPv6, and clickApply.

The following IPv6 features are available from the FortiOS web manager:

IPv6 policies
IPv6 security policies are created both for an IPv6 network and a transitional network. A transitional network is a
network that is transitioning over to IPv6 but must still have access to the Internet or must connect over an IPv4
network.

These policies allow for this specific type of traffic to travel between the IPv6 and IPv4 networks. The IPv6 options
for creating these policies is hidden by default. You must enable this feature under System > Config >
Features.

IPv6 policy route

IPv6 policy routing

IPv6 policy routing functions in the same was as IPv4 policy routing. To add an IPv6 policy route, go to Network
> Policy Routes and select Create New > IPv6 Policy Route.
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Adding an IPv6 Policy route

You can also use the following command to add IPv6 policy routes:

config router policy6
edit 0

set input-device <interface>
set src <ipv6_ip>
set dst <ipv6_ip>
set protocol <0-255>
set gateway <ipv6_ip>
set output-device <interface>
set tos <bit_pattern>
set tos-mask <bit_mask>

end

IPv6 security policies

IPv6 security policies support all the features supported by IPv4 security policies:

l Policy types and subtypes.
l NAT support including using the destination interface IP address, fixed port, and dynamic IP pools.
l All security features (antivirus, web filtering, application control, IPS, email filtering, DLP, VoIP, and ICAP).
l All traffic shaping options, including: shared traffic shaping, reverse shared traffic shaping, and per-IP traffic

shaping.
l All user and device authentication options.

IPv6 explicit web proxy

You can use the explicit web proxy for IPv6 traffic. To do this you need to:
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l Enable the IPv6 explicit web proxy from the CLI.
l Enable the explicit web proxy for one or more FortiGate interfaces. These interfaces also need IPv6 addresses.
l Add IPv6 web proxy security policies to allow the explicit web proxy to accept IPv6 traffic.

Use the following steps to set up a FortiGate unit to accept IPv6 traffic for the explicit web proxy at the Internal
interface and forward IPv6 explicit proxy traffic out the wan1 interface to the Internet.

1. Enter the following CLI command to enable the IPv6 explicit web proxy:
config web-proxy explicit

set status enable
set ipv6-status enable

end

2. Go to Network > Interfaces and edit the internal interface, select Enable Explicit Web Proxy and select OK.
3. Go to Policy & Objects > Proxy Policy and select Create New to add an IPv6 explicit web proxy security policy

with the following settings shown.
This IPv6 explicit web proxy policy allows traffic from all IPv6 IP addresses to connect through the explicit
web proxy and through the wan1 interface to any IPv6 addresses that are accessible from the wan1 interface.

If you have enabled both the IPv4 and the IPv6 explicit web proxy, you can combine
IPv4 and IPv6 addresses in a single explicit web proxy policy to allow both IPv4 and
IPv6 traffic through the proxy.

Example IPv6 Explicit Web Proxy security policy

Restricting the IP address of the explicit IPv6 web proxy

You can use the following command to restrict access to the IPv6 explicit web proxy using only one IPv6 address.
The IPv6 address that you specify must be the IPv6 address of an interface that the explicit HTTP proxy is
enabled on. You might want to use this option if the explicit web proxy is enabled on an interface with multiple
IPv6 addresses.

For example, to require users to connect to the IPv6 address 2001:db8:0:2::30 to connect to the explicit IPv6
HTTP proxy, use the following command:

config web-proxy explicit
set incoming-ipv6 2001:db8:0:2::30
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end

Restricting the outgoing source IP address of the IPv6 explicit web proxy

You can use the following command to restrict the source address of outgoing web proxy packets to a single IPv6
address. The IP address that you specify must be the IPv6 address of an interface that the explicit HTTP proxy is
enabled on. You might want to use this option if the explicit HTTP proxy is enabled on an interface with multiple
IPv6 addresses.

For example, to restrict the outgoing packet source address to 2001:db8:0:2::50:

config http-proxy explicit
set outgoing-ip6 2001:db8:0:2::50

end

VIP64

VIP64 policies can be used to configure static NAT virtual IPv6 address for IPv4 addresses. VIP64 can be
configured from the CLI using the following commands:

config firewall vip64
edit <zname_str>

set arp-reply {enable | disable}
set color <color_int>
set comment <comment_str>
set extip <address_ipv6>[-address_ipv6]
set extport <port_int>
set id <id_num_str>
set mappedip [<start_ipv4>-<end_ipv4>]
set mappedport <port_int>
set portforward {enable | disable}
set src-filter <addr_str>

end

VIP64 CLI Variables and Defaults

Variable Description Default

<zname_str> Enter the name of this virtual IP
address.

No default.

arp-reply
{enable | disable}

Select to respond to ARP requests for
this virtual IP address. enable

color <color_int> Enter the number of the color to use for
the group icon in the web-based
manager.

0

comment <comment_str> Enter comments relevant to the
configured virtual IP. No default.
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Variable Description Default

extip <address_ipv6>[-
address_ipv6]

Enter the IP address or address range
on the external interface that you want
to map to an address or address range
on the destination network.

If mappedip is an IP address range,
the FortiGate unit uses extip as the
first IP address in the external IP
address range, and calculates the last
IP address required to create an equal
number of external and mapped IP
addresses for one-to-one mapping.

To configure a dynamic virtual IP that
accepts connections destined for any IP
address, set extip to ::.

::

extport <port_int>

Enter the external port number that you
want to map to a port number on the
destination network.

This option only appears if
portforward is enabled.

If portforward is enabled and you
want to configure a static NAT virtual IP
that maps a range of external port
numbers to a range of destination port
numbers, set extport to the first port
number in the range. Then set
mappedport to the start and end of
the destination port range. The
FortiGate unit automatically calculates
the end of the extport port number
range.

0

id <id_num_str> Enter a unique identification number for
the configured virtual IP. Not checked
for uniqueness. Range 0 - 65535.

No default.
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Variable Description Default

mappedip
[<start_ipv4>-<end_
ipv4>]

Enter the IP address or IP address
range on the destination network to
which the external IP address is
mapped.

If mappedip is an IP address range,
the FortiGate unit uses extip as the
first IP address in the external IP
address range, and calculates the last
IP address required to create an equal
number of external and mapped IP
addresses for one-to-one mapping.

If mappedip is an IP address range,
the FortiGate unit uses extip as a
single IP address to create a one-to-
many mapping.

0.0.0.0

mappedport <port_int> Enter the port number on the
destination network to which the
external port number is mapped.

You can also enter a port number range
to forward packets to multiple ports on
the destination network.

For a static NAT virtual IP, if you add a
map to port range the FortiGate unit
calculates the external port number
range.

0

portforward
{enable | disable}

Select to enable port forwarding. You
must also specify the port forwarding
mappings by configuring extport and
mappedport.

disable

src-filter <addr_str> Enter a source address filter. Each
address must be in the form of an IPv4
subnet (x:x:x:x:x:x:x:x/n). Separate
addresses with spaces.

null

VIP46 policies can be used to configure static NAT virtual IPv4 address for IPv6 addresses. VIP46 can be
configured from the CLI using the following commands (see the table below for variable details):

config firewall vip46
edit <name_str>

set arp-reply {enable | disable}
set color <color_int>
set comment <comment_str>
set extip <address_ipv4>[-address_ipv4]
set extport <port_int>
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set id <id_num_str>
set mappedip [<start_ipv6>-<end_ipv6>]
set mappedport <port_int>
set portforward {enable | disable}
set src-filter <add_str>

end

VIP46 CLI Variables and Defaults

Variable Description Default

<name_str> Enter the name of this virtual IP
address.

No default.

arp-reply
{enable | disable}

Select to respond to ARP requests for
this virtual IP address. enable

color <color_int> Enter the number of the color to use for
the group icon in the web-based
manager.

0

comment <comment_str> Enter comments relevant to the
configured virtual IP. No default.

extip <address_ipv4>[-
address_ipv4]

Enter the IP address or address range
on the external interface that you want
to map to an address or address range
on the destination network.

If mappedip is an IP address range,
the FortiGate unit uses extip as the
first IP address in the external IP
address range, and calculates the last
IP address required to create an equal
number of external and mapped IP
addresses for one-to-one mapping.

To configure a dynamic virtual IP that
accepts connections destined for any IP
address, set extip to 0.0.0.0.

0.0.0.0
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Variable Description Default

extport <port_int>

Enter the external port number that you
want to map to a port number on the
destination network.

This option only appears if
portforward is enabled.

If portforward is enabled and you
want to configure a static NAT virtual IP
that maps a range of external port
numbers to a range of destination port
numbers, set extport to the first port
number in the range. Then set
mappedport to the start and end of
the destination port range. The
FortiGate unit automatically calculates
the end of the extport port number
range.

0

id <id_num_str> Enter a unique identification number for
the configured virtual IP. Not checked
for uniqueness. Range 0 - 65535.

No default.

mappedip
[<start_ipv6>-<end_
ipv6>]

Enter the IP address or IP address
range on the destination network to
which the external IP address is
mapped.

If mappedip is an IP address range, the
FortiGate unit uses extip as the first
IP address in the external IP address
range, and calculates the last IP
address required to create an equal
number of external and mapped IP
addresses for one-to-one mapping.

If mappedip is an IP address range,
the FortiGate unit uses extip as a
single IP address to create a one-to-
many mapping.

::
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Variable Description Default

mappedport <port_int> Enter the port number on the
destination network to which the
external port number is mapped.

You can also enter a port number range
to forward packets to multiple ports on
the destination network.

For a static NAT virtual IP, if you add a
map to port range the FortiGate unit
calculates the external port number
range.

0

portforward
{enable | disable}

Select to enable port forwarding. You
must also specify the port forwarding
mappings by configuring extport and
mappedport.

disable

src-filter <addr_str> Enter a source address filter. Each
address must be in the form of an IPv4
subnet (x.x.x.x/n). Separate addresses
with spaces.

null

IPv6 Network Address Translation
NAT66, NAT64, and DNS64 are now supported for IPv6. These options provide IPv6 NAT and DNS capabilities
withIPv6-IPv4 tunnelling or dual stack configurations. The commands are available only in the CLI.

Fortinet supports all features described in RFC 6146. However, for DNS64 there is no support for handling
Domain Name System Security Extensions (DNSSEC). DNSSEC is for securing types of information that are
provided by the DNS as used on an IP network or networks. You can find more information about DNS64 in RFC
6147.

NAT64 and DNS64 (DNS proxy)

NAT64 is used to translate IPv6 addresses to IPv4 addresses so that a client on an IPv6 network can
communicate transparently with a server on an IPv4 network.

NAT64 is usually implemented in combination with the DNS proxy called DNS64. DNS64 synthesizes AAAA
records from A records and is used to synthesize IPv6 addresses for hosts that only have IPv4 addresses. ‘DNS
proxy’ and ‘DNS64’ are interchangeable terms.
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Example NAT64 configuration

With a NAT64 and DNS64 configuration in place on a FortiGate unit, clients on an IPv6 network can transparently
connect to addresses on an IPv4 network. NAT64 and DNS64 perform the IPv4 to IPv6 transition, allowing clients
that have already switched to IPv6 addresses to continue communicating with servers that still use IPv4
addresses.

To enable NAT64 and DNS64, use the following CLI commands:

Enable NAT64

config system nat64
set status enable

end

Enable the DNS proxy on the IPv6 interface

config system dns-server
edit internal
end

In your DHCP6 configuration, configure the IPv6 interface IP address as the DNS6 server IP address. The
FortiGate will proxy DNS requests to the system DNS server.

config system dhcp6 server
edit 1

set interface internal
config ip-range

edit 1
set start-ip 2001:db8:1::11
set end-ip 2001:db8:1::20

end
set dns-server1 2001:db8:1::10

end

NAT64 policies

You can configure security policies for NAT64 using the web-based manager. For these options to appear, the
feature must be enabled using System > Feature Visibility. You can then configure the policies under Policy
& Objects > NAT64 Policy.
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NAT64 policies and can also be configured from the CLI using the following command:

config firewall policy64

In the following section, you will configure a NAT64 policy that allows connections from an internal IPv6 network
to an external IPv4 network.

Configuring NAT64 to allow a host on the IPv6 network to connect to the Internet server

In this example, the Internal IPv6 network address is 2001:db8:1::/48 and the external IPv4 network address is
172.20.120.0/24. NAT64 is configured to allow a user on the internal network to connect to the server at IPv4
address 172.20.120.12. In this configuration, sessions exiting the wan1 interface must have their source address
changed to an IPv4 address in the range 172.20.120.200 to 172.20.120.210.

Enter the following command to enable NAT64:

config system nat64
set status enable

end

Enabling NAT64 with the config system nat64 command means that all IPv6 traffic received by the current
VDOM can be subject to NAT64 if the source and destination address matches an NAT64 security policy.

By default, the setting always-synthesize-aaaa-record is enabled. If you disable this setting, the DNS
proxy (DNS64) will attempt to find an AAAA records for queries to domain names and therefore resolve the host
names to IPv6 addresses. If the DNS proxy cannot find an AAAA record, it synthesizes one by adding the NAT64
prefix to the A record.

By using the nat64-prefix option of the config system nat64 command to change the default nat64
prefix from the well-known prefix of 64:ff9b::/96 and setting always-synthesize-aaaa-record to enable
(default), the DNS proxy does not check for AAAA records but rather synthesizes AAAA records.

As an alternative to the above entry, there is the optional configuration that would allow the resolution of CNAME
queries.

config system nat64
set status enable
set nat64-prefix 64:ff9b::/96
set always-synthesize-aaaa-record enable

end

Enter the following command to add an IPv6 firewall address for the internal network:

config firewall address6
edit internal-net6

set ip6 2001:db8:1::/48
end

Enter the following command to add an IPv4 firewall address for the external network:

config firewall address
edit external-net4

set subnet 172.20.120.0/24
set associated-interface wan1

end

Enter the following command to add an IP pool containing the IPv4 address that the should become the source
address of the packets exiting the wan1 interface:

config firewall ippool
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edit exit-pool4
set startip 172.20.120.200
set endip 172.20.120.210

end

Enter the following command to add a NAT64 policy that allows connections from the internal IPv6 network to the
external IPv4 network:

config firewall policy64
edit 0

set srcintf internal
set srcaddr internal-net6
set dstintf wan1
set dstaddr external-net4
set action accept
set schedule always
set service ALL
set logtraffic enable
set ippool enable
set poolname exit-pool4

end

The srcaddr can be any IPv6 firewall address and the dstaddr can be any IPv4 firewall address.

Other NAT64 policy options include fixedport, which can be used to prevent NAT64 from changing the
destination port. You can also configure traffic shaping for NAT64 policies.

How a host on the internal IPv6 network communicates with example.server.com that only has IPv4
address on the Internet

1. The host on the internal network does a DNS lookup for example.server.com by sending a DNS query for an AAAA
record for example.server.com.

2. The DNS query is intercepted by the FortiGate DNS proxy.
3. The DNS proxy attempts to resolve the query with a DNS server on the Internet and discovers that there are no

AAAA records for example.server.com.
4. The previous step is skipped if always-synthesize-aaaa-record is enabled.
5. The DNS proxy performs an A-record query for example.server.com and gets back an RRSet containing a single A

record with the IPv4 address 172.20.120.12.
6. The DNS proxy then synthesizes an AAAA record. The IPv6 address in the AAAA record begins with the configured

NAT64 prefix in the upper 96 bits and the received IPv4 address in the lower 32 bits. By default, the resulting IPv6
address is 64:ff9b::172.20.120.12.

7. The host on the internal network receives the synthetic AAAA record and sends a packet to the destination address
64:ff9b::172.20.120.12.

8. The packet is routed to the FortiGate internal interface where it is accepted by the NAT64 security policy.
9. The FortiGate unit translates the destination address of the packets from IPv6 address 64:ff9b::172.20.120.12 to

IPv4 address 172.20.120.12 and translates the source address of the packets to 172.20.120.200 (or another
address in the IP pool range) and forwards the packets out the wan1 interface to the Internet.

NAT66

NAT66 is used for translating an IPv6 source or destination address to a different IPv6 source or destination
address. NAT66 is not as common or as important as IPv4 NAT, as many IPv6 addresses do not need NAT66 as
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much as IPv4 NAT. However, NAT66 can be useful for a number of reasons. For example, you may have
changed the IP addresses of some devices on your network but want traffic to still appear to be coming from their
old addresses. You can use NAT66 to translate the source addresses of packets from the devices to their old
source addresses.

In FortiOS, NAT66 options can be added to an IPv6 security policy from the CLI. Configuring NAT66 is very
similar to configuring NAT in an IPv4 security policy. For example, use the following command to add an IPv6
security policy that translates the source address of IPv6 packets to the address of the destination interface
(similar to IPv4 source NAT:

config firewall policy6
edit 0

set srcintf internal
set dstintf wan1
set srcaddr internal_net
set dstaddr all
set action accept
set schedule always
set service ALL
set nat enable

end

Its also can be useful to translate one IPv6 source address to another address that is not the same as the address
of the exiting interface. You can do this using IP pools. For example, enter the following command to add an IPv6
IP pool containing one IPv6 IP address:

config firewall ippool6
edit example_6_pool

set startip 2001:db8::
set endip 2001:db8::

end

Enter the following command to add an IPv6 firewall address that contains a single IPv6 IP address.

config firewall address6
edit device_address

set ip6 2001:db8::132/128
end

Enter the following command to add an IPv6 security policy that accepts packets from a device with IP address
2001:db8::132 and translates the source address to 2001:db8::.

config firewall policy6
edit 0

set srcintf internal
set dstintf wan1
set srcaddr device_address
set dstaddr all
set action accept
set schedule always
set service ALL
set nat enable
set ippool enable
set poolname example_6_pool

end
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NAT66 destination address translation

NAT66 can also be used to translate destination addresses. This is done in an IPv6 policy by using IPv6 virtual
IPs. For example, enter the following command to add an IPv6 virtual IP that maps the destination address
2001:db8::dd to 2001:db8::ee.

config firewall vip6
edit example-vip6

set extip 2001:db8::dd
set mappedip 2001:db8::ee

end

Enter the following command to add an IPv6 security policy that accepts packets with a destination address
2001:db8::dd and translates that destination address to 2001:db8::ee.

config firewall policy6
edit 0

set srcintf internal
set dstintf wan1
set srcaddr all
set dstaddr example-vip6
set action accept
set schedule always
set service ALL

end

NAT64 and NAT66 session failover

The FortiGate Clustering Protocol (FGCP) supports IPv6, NAT64, and NAT66 session failover. If session pickup
is enabled, these sessions are synchronized between cluster members and, after an HA failover, the sessions will
resume with only minimal interruption.

NAT46

NAT46 is used to translate IPv4 addresses to IPv6 addresses so that a client on an IPv4 network can
communicate transparently with a server on an IPv6 network.

To enable NAT46, use the following CLI command:

config firewall vip46

NAT46 policies

Security policies for NAT46 can be configured from the web-based manager. For these options to appear in the
web-based manager, this feature must be enabled using System > Feature Visibility. You can then configure
the policies under Policy & Objects > NAT46 Policy.

NAT46 policies and can also be configured from the CLI using the following command:

config firewall policy46

ICMPv6
Internet Control Message Protocol version 6 (ICMPv6) is the new implementation of the Internet Control
Message Protocol (ICMP) that is part of Internet Protocol version 6 (IPv6). The ICMPv6 protocol is defined in RFC
4443.
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ICMPv6 is a multipurpose protocol. It performs such things as:

l error reporting in packet processing
l diagnostic functions
l Neighbor Discovery process
l IPv6 multicast membership reporting

It is also designed as a framework to use extensions for use with future implementations and changes.

Examples of extensions that have already been written for ICMPv6:

l Neighbor Discovery Protocol (NDP) - a node discovery protocol in IPv6 which replaces and enhances functions of
ARP.

l Secure Neighbor Discovery Protocol (SEND) - an extension of NDPwith extra security.
l Multicast Router Discovery (MRD) - allows discovery of multicast routers.
l ICMPv6 messages use IPv6 packets for transportation and can include IPv6 extension headers. ICMPv6 includes

some of the functionality that in IPv4 was distributed among protocols such as ICMPv4, ARP (Address Resolution
Protocol), and IGMP (Internet Group Membership Protocol version 3).

l ICMPv6 has simplified the communication process by eliminating obsolete messages.

ICMPv6 messages are subdivided into two classes: error messages and information messages.

Error Messages are divided into four categories:

l Destination Unreachable
l Time Exceeded
l Packet Too Big
l Parameter Problems
l Information messages are divided into three groups:
l Diagnostic messages
l Neighbor Discovery messages
l Messages for the management of multicast groups.

ICMPv6 Types and Codes

ICMPv6 has a number of messages that are identified by the “Type” field. Some of these types have assigned
“Code” fields as well. The table below shows the different types of ICMP Types with their associated codes if
there are any.

Type codes 0 − 127 are error messages and type codes 128 − 255 are for information messages.
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ICMPv6 Types and Codes

Type # Type Name Code

0 Reserved 0 - no route to destination

1 - communication with destination administratively
prohibited

2 - beyond scope of source address

3 - address unreachable

4 - port unreachable

5 - source address failed ingress/egress policy

6 - reject route to destination

7 - Error in Source Routing Header

1 Destination Unreachable

2 Packet Too Big

3 Time Exceeded
0 - hop limit exceeded in transit

1 - fragment reassembly time exceeded

4 Parameter Problem 0 - erroneous header field encountered

1 - unrecognized Next Header type encountered

2 - unrecognized IPv6 option encountered

100 Private Experimentation

101 Private Experimentation

102 -
126 Unassigned

127 Reserved for expansion if ICMPv6
error messages

128 Echo Request

129 Echo Replay

130 Multicast Listener Query
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Type # Type Name Code

131 Multicast Listener Report

132 Multicast Listener Done

133 Router Solicitation

134 Router Advertisement

135 Neighbor Solicitation

136 Neighbor Advertisement

137 Redirect Message

138 Router Renumbering

0 - Router Renumbering Command

1 - Router Renumbering Result

255 - Sequence Number Reset

139 ICMPNode Information Query 0 - The Data field contains an IPv6 address which is the
Subject of this Query.

1 - The Data field contains a name which is the Subject of
this Query, or is empty, as in the case of a NOOP.

2 - The Data field contains an IPv4 address which is the
Subject of this Query.

140 ICMPNode Information Response

0 - A successful reply. The Reply Data field may or may not
be empty.

1 - The Responder refuses to supply the answer. The
Reply Data field will be empty.

2 - The Qtype of the Query is unknown to the Responder.
The Reply Data field will be empty.

141 Inverse Neighbor Discovery
Solicitation Message

142 Inverse Neighbor Discovery
Advertisement Message

143 Version 2 Multicast Listener Report

144 Home Agent Address Discovery
Request Message
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Type # Type Name Code

145 Home Agent Address Discovery
Reply Message

146 Mobile Prefix Solicitation

147 Mobile Prefix Advertisement

148 Certification Path Solicitation
Message

149 Certification Path Advertisement
Message

150
ICMPmessages utilized by
experimental mobility protocols
such as Seamoby

151 Multicast Router Advertisement

152 Multicast Router Solicitation

153 Multicast Router Termination

154 FMIPv6 Messages

155 RPL Control Message

156 ILNPv6 Locator Update Message

157 Duplicate Address Request

158 Duplicate Address Confirmation

159 −
199

Unassigned

200 Private experimentation

201 Private experimentation

255 Reserved for expansion of ICMPv6
informational messages

IPv6 in dynamic routing
Unless otherwise stated, routing protocols apply to IPv4 addressing. This is the standard address format used.
However, IPv6 is becoming more popular and new versions of the dynamic routing protocols have been
introduced.
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As with most advanced routing features on your FortiGate unit, IPv6 settings for dynamic routing protocols must
be enabled before they will be visible in the GUI. To enable IPv6 configuration in the GUI, enable it in System
> Feature Visibility. Alternatively, you can directly configure IPv6 for RIP, BGP, or OSPF protocols using CLI
commands.

Dual stack routing
Dual stack routing implements dual IP layers in hosts and routers, supporting both IPv6 and IPv4. A dual stack
architecture supports both IPv4 and IPv6 traffic and routes the appropriate traffic as required to any device on the
network. Administrators can update network components and applications to IPv6 on their own schedule, and
even maintain some IPv4 support indefinitely if that is necessary. Devices that are on this type of network, and
connect to the Internet, can query Internet DNS servers for both IPv4 and IPv6 addresses. If the Internet site
supports IPv6, the device can easily connect using the IPv6 address. If the Internet site does not support IPv6,
then the device can connect using the IPv4 addresses.

In FortiOS, dual stack architecture it is not comprised merely of basic addressing functions that operate in both
versions of IP. The other features of the appliance, such as UTM and routing, can also use both IP stacks.

If an organization with a mixed network uses an Internet service provider that does not support IPv6, they can use
an IPv6 tunnel broker to connect to IPv6 addresses that are on the Internet. FortiOS supports IPv6 tunnelling over
IPv4 networks to tunnel brokers. The tunnel broker extracts the IPv6 packets from the tunnel and routes them to
their destinations.

IPv6 tunnelling
IPv6 Tunnelling is the act of tunnelling IPv6 packets from an IPv6 network through an IPv4 network to another
IPv6 network. Unlike NAT, once the packet reaches its final destination, the true originating address of the sender
will still be readable. The IPv6 packets are encapsulated within packets with IPv4 headers, which carry their IPv6
payload through the IPv4 network.

The key to IPv6 tunnelling is the ability of the two devices to be dual stack compatible in order to work with both
IPv4 and IPv6 at the same time. In the process, the entry node of the tunnel portion of the path will create an
encapsulating IPv4 header and transmit the encapsulated packet. The exit node at the end of the tunnel receives
the encapsulated packet, removes the IPv4 header, updates the IPv6 header, and processes the packet.

There are two types of tunnels in IPv6:

Automatic tunnels: Automatic tunnels are configured by using IPv4 address information embedded in an IPv6
address – the IPv6 address of the destination host includes information about which IPv4 address the packet
should be tunnelled to.

Configured tunnels:Configured tunnels must be configured manually. These tunnels are used when using IPv6
addresses that do not have any embedded IPv4 information. The IPv6 and IPv4 addresses of the endpoints of the
tunnel must be specified.

Tunnel configuration

There are a few ways in which the tunnelling can be performed depending on which segment of the path between
the endpoints of the session the encapsulation takes place.

Host to Host:Dual Stack capable hosts that are interconnected by an IPv4 infrastructure can tunnel IPv6
packets between themselves. In this case, the tunnel spans the entire path taken by the IPv6 packets.
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Network Device to Host: Dual Stack capable network devices can tunnel IPv6 packets to their final destination
IPv6 or IPv4 host. This tunnel spans only the last segment of the path taken by the IPv6 packets.

The node that does the encapsulation needs to maintain soft state information about each tunnel in order to
process the IPv6 packets.

Use the following command to tunnel IPv6 traffic over an IPv4 network. The IPv6 interface is configured under
config system interface. The command to do the reverse is config system ipv6-tunnel. These
commands are not available in Transparent mode.

config system sit-tunnel
edit <tunnel name>

set destination <tunnel _address>
set interface <name>
set ip6 <address_ipv6>
set source <address_ipv4>

end

Variable Description Default

edit <tunnel_name> Enter a name for the IPv6 tunnel. No default.

destination <tunnel_
address>

The destination IPv4 address for this
tunnel. 0.0.0.0

interface <name> The interface used to send and
receive traffic for this tunnel.

No default.

ip6 <address_ipv6> The IPv6 address for this tunnel. No default.

source <address_ipv4> The source IPv4 address for this
tunnel.

0.0.0.0

Tunnelling IPv6 through IPsec VPN

A variation on tunnelling IPv6 through IPv4 is to use an IPsec VPN tunnel between two FortiGate devices.
FortiOS supports IPv6 over IPsec. In this sort of scenario, two networks using IPv6 behind FortiGate units are
separated by the Internet, which uses IPv4. An IPsec VPN tunnel is created between the FortiGate units and a
tunnel is created over the IPv4-based Internet, but the traffic in the tunnel is IPv6. This has the additional
advantage of securing the traffic.

For configuration information, see IPv6 IPsec VPN on page 2264.

SIP over IPv6
FortiOS supports Sessions Initiate Protocol (SIP) over IPv6. The SIP application-level gateway (ALG) can process
SIPmessages that use IPv6 addresses in the headers, bodies, and in the transport stack. The SIP ALG cannot
modify the IPv6 addresses in the SIP headers so FortiGate units cannot perform SIP or RTPNAT over IPv6 and
also cannot translate between IPv6 and IPv4 addresses.

In the scenario shown below, a SIP phone connects to the Internet through a FortiGate unit operating. The phone
and the SIP and RTP servers all have IPv6 addresses.
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The FortiGate unit has IPv6 security policies that accept SIP sessions. The SIP ALG understands IPv6 addresses
and can forward IPv6 sessions to their destinations. Using SIP application control features the SIP ALG can also
apply rate limiting and other settings to SIP sessions.

To enable SIP support for IPv6 add an IPv6 security policy that accepts SIP packets and includes a VoIP profile.

New Fortinet FortiGate IPv6 MIB fields
The following IPv6 MIB fields have been added to the Fortinet FortiGate MIB. These MIB entries can be used to
display IPv6 session and policy statistics.

l IPv6 Session Counters:

fgSysSes6Count
fgSysSes6Rate1
fgSysSes6Rate10
fgSysSes6Rate30
fgSysSes6Rate60

l IPv6 Policy Statistics:

fgFwPol6StatsTable
fgFwPol6StatsEntry
FgFwPol6StatsEntry
fgFwPol6ID
fgFwPol6PktCount
fgFwPol6ByteCount

l IPv6 Session Statistics:

fgIp6SessStatsTable
fgIp6SessStatsEntry
FgIp6SessStatsEntry
fgIp6SessNumber

The fgSysSesCount and fgSysSesRateXMIBs report statistics for IPv4 plus IPv6 sessions combined. This
behavior was not changed.
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New OIDs

The following OIDs have been added:

FORTINET-FORTIGATE-MIB:fortinet.fnFortiGateMib.fgSystem.fgSystemInfo
.fgSysSes6Count   1.3.6.1.4.1.12356.101.4.1.15
.fgSysSesRate1    1.3.6.1.4.1.12356.101.4.1.16
.fgSysSesRate10   1.3.6.1.4.1.12356.101.4.1.17
.fgSysSesRate30   1.3.6.1.4.1.12356.101.4.1.18
.fgSysSesRate60   1.3.6.1.4.1.12356.101.4.1.19

FORTINET-FORTIGATE-MIB:fortinet.fnFortiGateMib.fgFirewall.fgFwPolicies.fgFwPolTables
.fgFwPol6StatsTable.fgFwPol6StatsEntry.fgFwPol6ID   1.3.6.1.4.1.12356.101.5.1.2.2.1.1
.fgFwPol6StatsTable.fgFwPol6StatsEntry.fgFwPol6PktCount   1.3.6.1.4.1.12356.101.5.1.2.2.1.

2
.fgFwPol6StatsTable.fgFwPol6StatsEntry.fgFwPol6ByteCount   1.3.6.1.4.1.12356.101.5.1.2.2.1

.3

FORTINET-FORTIGATE-MIB:fortinet.fnFortiGateMib.fgInetProto.fgInetProtoTables
.fgIp6SessStatsTable.fgIp6SessStatsEntry.fgIp6SessNumber 1.3.6.1.4.1.12356.101.11.2.3.1.1

EXAMPLE SNMP get/walk output
// Session6 stats excerpt from sysinfo:
snmpwalk -v2c -cpublic 192.168.1.111 1.3.6.1.4.1.12356.101.4
FORTINET-FORTIGATE-MIB::fgSysSes6Count.0 = Gauge32: 203
FORTINET-FORTIGATE-MIB::fgSysSes6Rate1.0 = Gauge32: 10 Sessions Per Second
FORTINET-FORTIGATE-MIB::fgSysSes6Rate10.0 = Gauge32: 2 Sessions Per Second
FORTINET-FORTIGATE-MIB::fgSysSes6Rate30.0 = Gauge32: 1 Sessions Per Second
FORTINET-FORTIGATE-MIB::fgSysSes6Rate60.0 = Gauge32: 0 Sessions Per Second

// FwPolicy6 table:
snmpwalk -v2c -cpublic 192.168.1.111 1.3.6.1.4.1.12356.101.5.1.2.2
FORTINET-FORTIGATE-MIB::fgFwPol6ID.1.3 = INTEGER: 3
FORTINET-FORTIGATE-MIB::fgFwPol6ID.1.4 = INTEGER: 4
FORTINET-FORTIGATE-MIB::fgFwPol6PktCount.1.3 = Counter64: 4329
FORTINET-FORTIGATE-MIB::fgFwPol6PktCount.1.4 = Counter64: 0
FORTINET-FORTIGATE-MIB::fgFwPol6ByteCount.1.3 = Counter64: 317776
FORTINET-FORTIGATE-MIB::fgFwPol6ByteCount.1.4 = Counter64: 0

// IP6SessNumber:
snmpwalk -v2c -cpublic 192.168.1.111 1.3.6.1.4.1.12356.101.11.2.3.1
FORTINET-FORTIGATE-MIB::fgIp6SessNumber.1 = Counter32: 89

IPv6 Per-IP traffic shaper
You can add any Per-IP traffic shaper to an IPv6 security policy using the following command:

config firewall policy6
edit 0

set per-ip-shaper "new-perip-shaper"
end
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DHCPv6
You can use DHCPwith IPv6 using the CLI. To configure DHCP, ensure IPv6 is enabled by going to System
> Feature Visibility and enabling IPv6.

Use the CLI command

config system dhcp6

For more information on the configuration options, see the FortiGate CLI Reference.

DHCP delegated mode

Downstream IPv6 interfaces can receive address assignments on delegated subnets from a DHCP server that
serves an upstream interface.

DHCPv6-PD configuration

Enable DHCPv6 Prefix Delegation on upstream interface (port10):

config system interface
edit "port10"

config ipv6
set dhcp6-prefix-delegation enable

end
end

Assign delegated prefix on downstream interface (port1). Optionally, specific delegated prefixes can be specified:

config system interface
edit "port1"

config ipv6
set ip6-mode delegated
set ip6-upstream-interface "port10"
set ip6-subnet ::1:0:0:0:1/64
set ip6-send-adv enable
config ipv6-delegated-prefix-list

edit 1
set upstream-interface "port10"
set autonomous-flag enable
set onlink-flag enable
set subnet 0:0:0:100::/64

end
end

end

DHCPv6 Server configuration

Configuring a server that uses delegated prefix and DNS from upstream:

config system dhcp6 server
edit 1

set dns-service delegated
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set interface "wan2"
set upstream-interface "wan1"
set ip-mode delegated
set subnet 0:0:0:102::/64

end

DHCPv6 relay

You can use the following command to configure a FortiGate interface to relay DHCPv6 queries and responses
from one network to a network with a DHCPv6 server and back. The command enables DHCPv6 relay and
includes adding the IPv6 address of the DHCP server that the FortiGate unit relays DHCPv6 requests to:

config system interface
edit internal

config ipv6
set dhcp6-relay-service enable
set dhcp6-relay-type regular
set dhcp6-relay-ip 2001:db8:0:2::30

end

IPv6 forwarding

Policies, IPS, Application Control, flow-based antivirus, web filtering, and DLP

FortiOS fully supports flow-based inspection of IPv6 traffic. This includes full support for IPS, application control,
virus scanning, and web filtering.
To add flow-based inspection to IPv6 traffic go to Policy & Objects > IPv6 Policy and select Create New to
add an IPv6 Security Policy. Configure the policy to accept the traffic to be scanned. Under Security Profiles,
select the profiles to apply to the traffic.

Obtaining IPv6 addresses from an IPv6 DHCP server
From the CLI, you can configure any FortiGate interface to get an IPv6 address from an IPv6 DHCP server. For
example, to configure the wan2 interface to get an IPv6 address from an IPv6 DHCP server enter the following
command:

config system interface
edit wan2

config ipv6
set ip6-mode dhcp

end

Authentication Support

RADIUS

FortiOS's supports IPv6 RADIUS authentication. When configuring the FortiGate interface and the RADIUS
server (under config system interface and config user radius respectively), the server IP address
can be set as IPv6.
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Captive portal

Captive portal supports IPv6. It works with remote RADIUS authentication and WiFi interfaces.
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IPv6 Configuration

This section contains configuration information for IPv6 on FortiOS. Attempts are made to include scenarios in
each section to better assist with the configuration and to orient the information toward a particular task.

You will find information on the following:

By default IPv6 configurations do not appear in the web-based manager. You need to
enable the feature first.

To enable IPv6:

1. Go to System > Features.
2. Select IPv6 and clickApply.

IPv6 address groups

To create IPv6 address groups from existing IPv6 addresses - web-based manager

Your company has 3 internal servers with IPv6 addresses that it would like to group together for the purposes of a
number of policies.

1. Go to Policy & Objects > Addresses and select Create New > Address Group.
2. Select IPv6 Group, and fill out the fields with the following information:

Group Name Web_Server_Cluster

Members Web_Server-1

Web_Server-2

Web_Server-3

3. Select OK.

To create IPv6 address groups from existing IPv6 addresses - CLI

config firewall addrgrp6
edit Web_Server_Cluster

set member Web_Server-1 Web_Server-2 Web_Server-3
end

To verify that the addresses were added correctly

1. Go to Policy & Objects > Addresses. Check that the addresses have been added to the address list and that
they are correct.

2. From the CLI, enter the following commands:
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config firewall addgrp6
edit <the name of the address that you wish to verify>

Show full-configuration

IPv6 address ranges
You can configure IPv6 address ranges in both the GUI and the CLI.

To configure IPv6 address ranges - web-based manager:

1. Go to Policy & Objects > Addresses.
2. Set the Type to IP Range and enter the IPv6 addresses as shown:

To configure IPv6 address ranges - CLI:

config firewall address6
edit ipv6range

set type iprange
set start-ip 2001:db8:0:2::30
set end-ip 2001:db8:0:2::31

end

IPv6 firewall addresses

Scenario: Mail Server

You need to create an IPv6 address for the Mail Server on Port1 of your internal network. This server is on the
network off of port1.

l The IP address is 2001:db8:0:2::20/128
l There should be a tag for this address being for a server.

Configuring the Example using the GUI

1. Go to Policy & Objects > Objects > Addresses and select Create New > Address.
2. Select IPv6 Address and fill out the fields with the following information
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Name Mail_Server

Type Subnet

IPv6 Address 2001:db8:0:2::20/128

3. Select OK.

Configuring the Example using the CLI

Enter the following CLI command:

config firewall address6
edit Mail_Server

set type ipprefix
set subnet 2001:db8:0:2::20/128

end

Scenario: First Floor Network

You need to create an IPv6 address for the subnet of the internal network off of Port1. These computers connect
to port1. The network uses the IPv6 addresses: fdde:5a7d:f40b:2e9d:xxxx:xxxx:xxxx:xxxx

There should be a reference to this being the network for the 1st floor of the building.

1. Go to Policy & Objects > Objects > Addresses
2. Select Create New > Address.Select IPv6 Address and fill out the fields with the following information:

Name Internal_Subnet_1

Type Subnet / IP Range

IPv6 Address 2001:db8:0:2::/64

Comments Network for 1st Floor

3. Select OK.
4. Enter the following CLI command:

config firewall address6
edit Internal_Subnet_1

set comment "Network for 1st Floor"
set type ipprefix
set subnet 2001:db8:0:2::/64

end

Scenario: Accounting Team

You need to create an IPv6 address for the Accounting Team that's on the 1st Floor. These users are off of
various ports of the FortiGate, but they have all been assigned addresses between 2001:db8:0:2::2000 and
2001:db8:0:2::a000

Configuring the Example using the GUI

1. Go to Policy & Objects > Objects > Addresses and select Create New > Address.
2. Select IPv6 Address and fill out the fields with the following information

Name Accounting_Team
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Type IP Range

Subnet / IP Range 2001:db8:0:2::2000-2001:db8:0:2::a000

3. Select OK.

Configuring the Example using the CLI

Enter the following CLI command:

config firewall address6
edit Accounting_Team

set type iprange
set visibility enable
set start-ip 2001:db8:0:2::2000
set end-ip 2001:db8:0:2::a000
end

To verify that the addresses were added correctly:

1. Go to Policy & Objects > Objects > Addresses. Check that the addresses have been added to the address list
and that they are correct.

2. Enter the following CLI command:
config firewall address6

edit <the name of the address that you wish to verify>
Show full-configuration

ICMPv6
The IT Manager is doing some diagnostics and would like to temporarily block the successful replies of ICMP
Node information Responses between 2 IPv6 networks.

The ICMP type for ICMPNode informations responses is 140. The codes for a successful response is 0.

To configure ICMPv6 - web-based manager:

1. Go to Policy & Objects > Services and select Create New > Service.
2. Fill out the fields with the following information

Name diagnostic-test1

Service Type Firewall

Show in Service List Enabled

Category Uncategorized

Protocol Type ICMP6

Type 140

3. Select OK.
4. Enter the following CLI command:

config firewall service custom
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edit diagnostic-test1
set protocol ICMP6
set icmptype 140
set icmpcode 0
set visibility enable

end

To verify that the category was added correctly:

1. Go to Policy & Objects > Services. Check that the services have been added to the services list and that they
are correct.

2. Enter the following CLI command:
config firewall service custom

edit <the name of the service that you wish to verify>
show full-configuration

IPv6 IPsec VPN
This chapter describes how to configure your FortiGate unit’s IPv6 IPsec VPN functionality.

By default IPv6 configurations do not appear in the web-based manager. You need to
enable the feature first.

To enable IPv6:

1. Go to System > Features.
2. Select IPv6 and clickApply.

The topics in this section include:

l Overview of IPv6 IPsec support
l Configuring IPv6 IPsec VPNs
l Site-to-site IPv6 over IPv6 VPN example
l Site-to-site IPv4 over IPv6 VPN example
l Site-to-site IPv6 over IPv4 VPN example

Overview of IPv6 IPsec support

FortiOS supports route-based IPv6 IPsec, but not policy-based. This section describes how IPv6 IPsec support
differs from IPv4 IPsec support.

Where both the gateways and the protected networks use IPv6 addresses, sometimes called IPv6 over IPv6, you
can create either an auto-keyed or manually-keyed VPN. You can also combine IPv6 and IPv4 addressing in an
auto-keyed VPN in the following ways:

IPv4 over IPv6 The VPN gateways have IPv6 addresses.

The protected networks have IPv4 addresses. The phase 2 configurations
at either end use IPv4 selectors.
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IPv6 over IPv4

The VPN gateways have IPv4 addresses.

The protected networks use IPv6 addresses. The phase 2 configurations at
either end use IPv6 selectors.

Compared with IPv4 IPsec VPN functionality, there are some limitations:

l Except for IPv6 over IPv4, remote gateways with Dynamic DNS are not supported.
l Selectors cannot be firewall address names. Only IP address, address range and subnet are supported.
l Redundant IPv6 tunnels are not supported.

Certificates

On a VPN with IPv6 phase 1 configuration, you can authenticate using VPN certificates in which the common
name (cn) is an IPv6 address. The cn-type keyword of the user peer command has an option, ipv6, to
support this.

Configuring IPv6 IPsec VPNs

Configuration of an IPv6 IPsec VPN follows the same sequence as for an IPv4 route-based VPN: phase 1
settings, phase 2 settings, security policies, and routing.

Phase 1 configuration

In the web-based manager, you define the Phase 1 as IPv6 in the Advanced settings. Enable the IPv6 Version
check box. You can then enter an IPv6 address for the remote gateway.

In the CLI, you define an IPsec phase 1 configuration as IPv6 by setting ip-version to 6. Its default value is 4.
Then, the local-gw and remote-gw keywords are hidden and the corresponding local-gw6 and remote-
gw6 keywords are available. The values for local-gw6 and remote-gw6 must be IPv6 addresses. For
example:

config vpn ipsec phase1-interface
edit tunnel6

set ip-version 6
set remote-gw6 0:123:4567::1234
set interface port3
set proposal 3des-md5

end

Phase 2 configuration

To create an IPv6 IPsec phase 2 configuration in the web-based manager, you need to define IPv6 selectors in
the Advanced settings. Change the default “0.0.0.0/0” address for Source address and Destination address to the
IPv6 value “::/0”. If needed, enter specific IPv6 addresses, address ranges or subnet addresses in these fields.

In the CLI, set src-addr-type and dst-addr-type to ip6, range6 or subnet6 to specify IPv6 selectors.
By default, zero selectors are entered, “::/0” for the subnet6 address type, for example. The simplest IPv6
phase 2 configuration looks like this:

config vpn ipsec phase2-interface
edit tunnel6_p2

set phase1name tunnel6
set proposal 3des-md5
set src-addr-type subnet6
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set dst-addr-type subnet6
end

Security policies

To complete the VPN configuration, you need a security policy in each direction to permit traffic between the
protected network’s port and the IPsec interface. You need IPv6 policies unless the VPN is IPv4 over IPv6.

Routing

Appropriate routing is needed for both the IPsec packets and the encapsulated traffic within them. You need a
route, which could be the default route, to the remote VPN gateway via the appropriate interface. You also need a
route to the remote protected network via the IPsec interface.

To create a static route - web-based manager:

1. Go to Network > Static Routes.
2. Select the drop-down arrow on the Create New button and select IPv6 Route.
3. Enter the information and select OK.

To create a static route - CLI:

1. In the CLI, use the router static6 command. For example, where the remote network is
fec0:0000:0000:0004::/64 and the IPsec interface is toB:

config router static6
edit 1

set device port2
set dst 0::/0

next
edit 2

set device toB
set dst fec0:0000:0000:0004::/64

next
end

If the VPN is IPV4 over IPv6, the route to the remote protected network is an IPv4 route. If the VPN is IPv6 over
IPv4, the route to the remote VPN gateway is an IPv4 route.

Site-to-site IPv6 over IPv6 VPN example

In this example, computers on IPv6-addressed private networks communicate securely over public IPv6
infrastructure.
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Example IPv6-over-IPv6 VPN topology

Configure FortiGate A interfaces

Port 2 connects to the public network and port 3 connects to the local network.

config system interface
edit port2

config ipv6
set ip6-address fec0::0001:209:0fff:fe83:25f2/64

end
next
edit port3

config ipv6
set ip6-address fec0::0000:209:0fff:fe83:25f3/64

end
next

end

Configure FortiGate A IPsec settings

The phase 1 configuration creates a virtual IPsec interface on port 2 and sets the remote gateway to the public IP
address FortiGate B. This configuration is the same as for an IPv4 route-based VPN, except that ip-version is
set to 6 and the remote-gw6 keyword is used to specify an IPv6 remote gateway address.

config vpn ipsec phase1-interface
edit toB

set ip-version 6
set interface port2

2267 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 17 - IPv6 IPv6 Configuration

set remote-gw6 fec0:0000:0000:0003:209:0fff:fe83:25c7
set dpd enable
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end

By default, phase 2 selectors are set to accept all subnet addresses for source and destination. The default
setting for src-addr-type and dst-addr-type is subnet. The IPv6 equivalent is subnet. The default
subnet addresses are 0.0.0.0/0 for IPv4, ::/0 for IPv6.

config vpn ipsec phase2-interface
edit toB2

set phase1name toB
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end

Configure FortiGate A security policies

Security policies are required to allow traffic between port3 and the IPsec interface toB in each direction. The
address all6must be defined using the firewall address6 command as ::/0.

config firewall policy6
edit 1

set srcintf port3
set dstintf toB
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toB
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end

Configure FortiGate A routing

This simple example requires just two static routes. Traffic to the protected network behind FortiGate B is routed
via the virtual IPsec interface toB. A default route sends all IPv6 traffic out on port2.

config router static6
edit 1

set device port2
set dst 0::/0

next
edit 2

set device toB
set dst fec0:0000:0000:0004::/64

end

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2268



IPv6 Configuration Chapter 17 - IPv6

Configure FortiGate B

The configuration of FortiGate B is very similar to that of FortiGate A. A virtual IPsec interface toA is configured
on port2 and its remote gateway is the public IP address of FortiGate A. Security policies enable traffic to pass
between the private network and the IPsec interface. Routing ensures traffic for the private network behind
FortiGate A goes through the VPN and that all IPv6 packets are routed to the public network.

config system interface
edit port2

config ipv6
set ip6-address fec0::0003:209:0fff:fe83:25c7/64

end
next
edit port3

config ipv6
set ip6-address fec0::0004:209:0fff:fe83:2569/64

end
end

config vpn ipsec phase1-interface
edit toA

set ip-version 6
set interface port2
set remote-gw6 fec0:0000:0000:0001:209:0fff:fe83:25f2
set dpd enable
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end
config vpn ipsec phase2-interface

edit toA2
set phase1name toA
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end
config firewall policy6

edit 1
set srcintf port3
set dstintf toA
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toA
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end
config router static6

edit 1
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set device port2
set dst 0::/0

next
edit 2

set device toA
set dst fec0:0000:0000:0000::/64

end

Site-to-site IPv4 over IPv6 VPN example

In this example, two private networks with IPv4 addressing communicate securely over IPv6 infrastructure.

Example IPv4-over-IPv6 VPN topology

Configure FortiGate A interfaces

Port 2 connects to the IPv6 public network and port 3 connects to the IPv4 LAN.

config system interface
edit port2

config ipv6
set ip6-address fec0::0001:209:0fff:fe83:25f2/64

end
next
edit port3

set 192.168.2.1/24
end
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Configure FortiGate A IPsec settings

The phase 1 configuration is the same as in the IPv6 over IPv6 example.

config vpn ipsec phase1-interface
edit toB

set ip-version 6
set interface port2
set remote-gw6 fec0:0000:0000:0003:209:0fff:fe83:25c7
set dpd enable
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end

The phase 2 configuration is the same as you would use for an IPv4 VPN. By default, phase 2 selectors are set to
accept all subnet addresses for source and destination.

config vpn ipsec phase2-interface
edit toB2

set phase1name toB
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable

end

Configure FortiGate A security policies

Security policies are required to allow traffic between port3 and the IPsec interface toB in each direction. These
are IPv4 security policies.

config firewall policy
edit 1

set srcintf port3
set dstintf toB
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toB
set dstintf port3
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always

end

Configure FortiGate A routing

This simple example requires just two static routes. Traffic to the protected network behind FortiGate B is routed
via the virtual IPsec interface toB using an IPv4 static route. A default route sends all IPv6 traffic, including the
IPv6 IPsec packets, out on port2.

config router static6
edit 1

set device port2
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set dst 0::/0
next
edit 2

set device toB
set dst 192.168.3.0/24

end

Configure FortiGate B

The configuration of FortiGate B is very similar to that of FortiGate A. A virtual IPsec interface toA is configured
on port2 and its remote gateway is the public IP address of FortiGate A. The IPsec phase 2 configuration has
IPv4 selectors.

IPv4 security policies enable traffic to pass between the private network and the IPsec interface. An IPv4 static
route ensures traffic for the private network behind FortiGate A goes through the VPN and an IPv6 static route
ensures that all IPv6 packets are routed to the public network.

config system interface
edit port2

config ipv6
set ip6-address fec0::0003:fe83:25c7/64

end
next
edit port3

set 192.168.3.1/24
end

config vpn ipsec phase1-interface
edit toA

set ip-version 6
set interface port2
set remote-gw6 fec0:0000:0000:0001:209:0fff:fe83:25f2
set dpd enable
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end
config vpn ipsec phase2-interface

edit toA2
set phase1name toA
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable

end
config firewall policy

edit 1
set srcintf port3
set dstintf toA
set srcaddr all
set dstaddr all
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toA
set dstintf port3
set srcaddr all
set dstaddr all
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set action accept
set service ALL
set schedule always

end
config router static6

edit 1
set device port2
set dst 0::/0

next
edit 2

set device toA
set dst 192.168.2.0/24

end

Site-to-site IPv6 over IPv4 VPN example

In this example, IPv6-addressed private networks communicate securely over IPv4 public infrastructure.

Example IPv6-over-IPv4 VPN topology

Configure FortiGate A interfaces

Port 2 connects to the IPv4 public network and port 3 connects to the IPv6 LAN.

config system interface
edit port2

set 10.0.0.1/24
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next
edit port3
config ipv6

set ip6-address fec0::0001:209:0fff:fe83:25f3/64
end

Configure FortiGate A IPsec settings

The phase 1 configuration uses IPv4 addressing.

config vpn ipsec phase1-interface
edit toB

set interface port2
set remote-gw 10.0.1.1
set dpd enable
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end

The phase 2 configuration uses IPv6 selectors. By default, phase 2 selectors are set to accept all subnet
addresses for source and destination. The default setting for src-addr-type and dst-addr-type is
subnet. The IPv6 equivalent is subnet6. The default subnet addresses are 0.0.0.0/0 for IPv4, ::/0 for IPv6.

config vpn ipsec phase2-interface
edit toB2

set phase1name toB
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end

Configure FortiGate A security policies

IPv6 security policies are required to allow traffic between port3 and the IPsec interface toB in each direction.
Define the address all6 using the firewall address6 command as ::/0.

config firewall policy6
edit 1

set srcintf port3
set dstintf toB
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toB
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end
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Configure FortiGate A routing

This simple example requires just two static routes. Traffic to the protected network behind FortiGate B is routed
via the virtual IPsec interface toB using an IPv6 static route. A default route sends all IPv4 traffic, including the
IPv4 IPsec packets, out on port2.

config router static6
edit 1

set device toB
set dst fec0:0000:0000:0004::/64

end
config router static

edit 1
set device port2
set dst 0.0.0.0/0
set gateway 10.0.0.254

end
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Configure FortiGate B

The configuration of FortiGate B is very similar to that of FortiGate A. A virtual IPsec interface toA is configured
on port2 and its remote gateway is the IPv4 public IP address of FortiGate A. The IPsec phase 2 configuration
has IPv6 selectors.

IPv6 security policies enable traffic to pass between the private network and the IPsec interface. An IPv6 static
route ensures traffic for the private network behind FortiGate A goes through the VPN and an IPv4 static route
ensures that all IPv4 packets are routed to the public network.

config system interface
edit port2

set 10.0.1.1/24
next
edit port3

config ipv6
set ip6-address fec0::0004:209:0fff:fe83:2569/64

end
config vpn ipsec phase1-interface

edit toA
set interface port2
set remote-gw 10.0.0.1
set dpd enable
set psksecret maryhadalittlelamb
set proposal 3des-md5 3des-sha1

end
config vpn ipsec phase2-interface

edit toA2
set phase1name toA
set proposal 3des-md5 3des-sha1
set pfs enable
set replay enable
set src-addr-type subnet6
set dst-addr-type subnet6

end
config firewall policy6

edit 1
set srcintf port3
set dstintf toA
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

next
edit 2

set srcintf toA
set dstintf port3
set srcaddr all6
set dstaddr all6
set action accept
set service ALL
set schedule always

end
config router static6

edit 1
set device toA
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set dst fec0:0000:0000:0000::/64
end

config router static
edit 1

set device port2
set gateway 10.0.1.254

end

TCP MSS values
TCPMSS values, which control the maximum amount of data that can be sent in a single packet, can be set for
IPv6 policies (for both the sender and the receiver). You can configure TCPMSS values in IPv6 using the
following CLI commands:

config firewall policy6
edit <index_int>

set tcp-mss-sender <value>
set tcp-mss-receiver <value>

end

BGP and IPv6
FortiGate units support IPv6 over BGP using the same config router bgp command as IPv4, but different
subcommands.

The main CLI keywords have IPv6 equivalents that are identified by the “6” on the end of the keyword, such as
with config network6 or set allowas-in6.

IPv6 BGP commands include:

config router bgp
set activate6 {enable | disable}
set allowas-in6 <max_num_AS_integer>
set allowas-in-enable6 {enable | disable}
set as-override6 {enable | disable}
set attribute-unchanged6 [as-path] [med] [next-hop]
set capability-default-originate6 {enable | disable}
set capability-graceful-restart6 {enable | disable}
set default-originate-route-map6 <routemap_str>
set distribute-list-in6 <access-list-name_str>
set distribute-list-out6 <access-list-name_str>
set filter-list-in6 <aspath-list-name_str>
set filter-list-out6 <aspath-list-name_str>
set maximum-prefix6 <prefix_integer>
set maximum-prefix-threshold6 <percentage_integer>
set maximum-prefix-warning-only6 {enable | disable}
set next-hop-self6 {enable | disable}
set prefix-list-in6 <prefix-list-name_str>
set prefix-list-out6 <prefix-list-name_str>
set remove-private-as6 {enable | disable}
set route-map-in6 <routemap-name_str>
set route-map-out6 <routemap-name_str>
set route-reflector-client6 {enable | disable}
set route-server-client6 {enable | disable}
set send-community6 {both | disable | extended | standard}
set soft-reconfiguration6 {enable | disable}
set unsuppress-map6 <route-map-name_str>
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config network6
config redistribute6

end

RIPng — RIP and IPv6
RIP next generation, or RIPng, is the version of RIP that supports IPv6.

This is an example of a typical small network configuration using RIPng routing.

Your internal R&D network is working on a project for a large international telecom company that uses IPv6. For
this reason, you have to run IPv6 on your internal network and you have decided to use only IPv6 addresses.

Your network has two FortiGate units running the RIPng dynamic routing protocol. Both FortiGate units are
connected to the ISP router and the internal network. This configuration provides some redundancy for the R&D
internal network enabling it to reach the internet at all times.

This section includes the following topics:

l Network layout and assumptions
l Configuring the FortiGate units system information
l Configuring RIPng on FortiGate units
l Configuring other network devices
l Testing the configuration
l Debugging IPv6 on RIPng

Network layout and assumptions

Basic network layout

Your internal R&D network is working on a project for a large international telecom company that uses IPv6. For
this reason, you have to run IPv6 on your internal network and you have decided to use only IPv6 addresses.

Your network has two FortiGate units running the RIPng dynamic routing protocol. Both FortiGate units are
connected to the ISP router and the internal network. This configuration provides some redundancy for the R&D
internal network enabling it to reach the internet at all times.

All internal computers use RIP routing, so no static routing is required. And all internal computers use IPv6
addresses.

Where possible in this example, the default values will be used or the most general settings. This is intended to
provide an easier configuration that will require less troubleshooting.

In this example the routers, networks, interfaces used, and IP addresses are as follows:
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Rip example network topology

Network Router Interface & Alias IPv6 address

R&D Router1 port1 (internal) 2002:A0B:6565:0:0:0:0:0

port2 (ISP) 2002:AC14:7865:0:0:0:0:0

Router2 port1 (internal) 2002:A0B:6566:0:0:0:0:0

port2 (ISP) 2002:AC14:7866:0:0:0:0:0

Network topology for the IPv6 RIPng example

Assumptions

The following assumptions have been made concerning this example:

l All FortiGate units have 5.0+ firmware, and are running factory default settings.
l All CLI and web-based manager navigation assumes the unit is running in NAT operating mode, with VDOMs

disabled.
l All FortiGate units have interfaces labelled port1 and port2 as required.
l All firewalls have been configured for each FortiGate unit to allow the required traffic to flow across interfaces.
l All network devices are support IPv6 and are running RIPng.

Configuring the FortiGate units system information

Each FortiGate unit needs IPv6 enabled, a new hostname, and interfaces configured.

To configure system information on Router1 - web-based manager:

1. Go to Dashboard.
2. ForHost name, select Change.
3. Enter “Router1”.
4. Go to System > Feature Visibility.
5. Enable IPv6 and clickApply.

2279 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 17 - IPv6 IPv6 Configuration

6. Go to Network > Interfaces.
7. Edit port1 (internal) interface.
8. Set the following information, and select OK.

Alias internal

IP/Netmask 2002:A0B:6565::/0

Administrative Access HTTPS SSH PING

Description Internal RnD network

Administrative Status Up

9. Edit port2 (ISP) interface.
10. Set the following information, and select OK.

Alias ISP

IP/Netmask 2002:AC14:7865::/0

Administrative Access HTTPS SSH PING

Description ISP and internet

Administrative Status Up

To configure system information on Router1 - CLI:

config system global
set hostname Router1
set gui-ipv6 enable

end
config system interface

edit port1
set alias internal
set allowaccess https ping ssh
set description "Internal RnD network"
config ipv6

set ip6-address 2002:a0b:6565::/0
end

next
edit port2

set alias ISP
set allowaccess https ping ssh
set description "ISP and internet"
config ipv6

set ip6-address 2002:AC14:7865::
end

end

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2280



IPv6 Configuration Chapter 17 - IPv6

To configure system information on Router2 - web-based manager:

1. Go to Dashboard.
2. ForHost name, select Change.
3. Enter “Router2”.
4. Go to System > Feature Visibility.
5. Enable IPv6 and clickApply.
6. Go to Network > Interfaces.
7. Edit port1 (internal) interface.
8. Set the following information, and select OK.

Alias internal

IP/Netmask 2002:A0B:6566::/0

Administrative Access HTTPS SSH PING

Description Internal RnD network

Administrative Status Up

9. Edit port2 (ISP) interface.
10. Set the following information, and select OK.

Alias ISP

IP/Netmask 2002:AC14:7866::/0

Administrative Access HTTPS SSH PING

Description ISP and internet

Administrative Status Up

To configure system information on Router2 - CLI:

config system global
set hostname Router2
set gui-ipv6 enable

end
config system interface

edit port1
set alias internal
set allowaccess https ping ssh
set description "Internal RnD network"
config ipv6

set ip6-address 2002:a0b:6566::/0
end

next
edit port2

set alias ISP
set allowaccess https ping ssh
set description "ISP and internet"
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config ipv6
set ip6-address 2002:AC14:7866::

end
end

Configuring RIPng on FortiGate units

Now that the interfaces are configured, you can configure RIPng on the FortiGate units.

There are only two networks and two interfaces to include — the internal network, and the ISP network. There is
no redistribution, and no authentication. In RIPng there is no specific command to include a subnet in the RIP
broadcasts. There is also no information required for the interfaces beyond including their name.

As this is a CLI only configuration, configure the ISP router and the other FortiGate unit as neighbors. This was
not part of the previous example as this feature is not offered in the web-based manager. Declaring neighbors in
the configuration like this will reduce the discovery traffic when the routers start up.

Since RIPng is not supported in the web-based manager, this section will only be entered in the CLI.

To configure RIPng on Router1 - CLI:

config router ripng
config interface

edit port1
next
edit port2
end

config neighbor
edit 1

set interface port1
set ipv6 2002:a0b:6566::/0

next
edit 2

set interface port2
set ipv6 2002:AC14:7805::/0

end

To configure RIPng on Router2 - CLI:

config router ripng
config interface

edit port1
next
edit port2
end

config neighbor
edit 1

set interface port1
set ipv6 2002:a0b:6565::/0

next
edit 2

set interface port2
set ipv6 2002:AC14:7805::/0

end
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Configuring other network devices

The other devices on the internal network all support IPv6, and are running RIPng where applicable. They only
need to know the internal interface network addresses of the FortiGate units.

The ISP routers need to know the FortiGate unit information such as IPv6 addresses.

Testing the configuration

In addition to normal testing of your network configuration, you must also test the IPv6 part of this example.

Testing the IPv6 RIPng information

There are some commands to use when checking that your RIPng information is correct on your network. These
are useful to check on your RIPng FortiGate units on your network. Comparing the output between devices will
help you understand your network better, and also track down any problems.

diagnose ipv6 address list

View the local scope IPv6 addresses used as next-hops by RIPng on the FortiGate unit.

diagnose ipv6 route list

View ipv6 addresses that are installed in the routing table.

get router info6 routing-table

View the routing table. This information is almost the same as the previous command (diagnose ipv6
route list) however it is presented in an easier to read format.

get router info6 rip interface external

View brief output on the RIP information for the interface listed. The information includes if the
interface is up or down, what routing protocol is being used, and whether passive interface or split
horizon are enabled.

get router info6 neighbor-cache list

View the IPv6/MAC address mapping. This also displays the interface index and name associated
with the address.

Debugging IPv6 on RIPng

The debug commands are very useful to see what is happening on the network at the packet level. There are a
few changes to debugging the packet flow when debugging IPv6.

The following CLI commands specify both IPv6 and RIP, so only RIPng packets will be reported. The output from
these commands will show you the RIPng traffic on your FortiGate unit including RECV, SEND, and UPDATE
actions.

The addresses are in IPv6 format.

diagnose debug enable
diagnose ipv6 router rip level info
diagnose ipv6 router rip all enable

These three commands will:

Turn on debugging in general

Set the debug level to information, a verbose reporting level

Turn on all RIP router settings
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Part of the information displayed from the debugging is the metric (hop count). If the metric is 16, then that
destination is unreachable since the maximum hop count is 15.

In general, you should see an update announcement, followed by the routing table being sent out, and a received
reply in response.

IPv6 RSSO support
RADIUS Single Sign-On (RSSO) is supported in IPv6, but can only be configured in the CLI:

config firewall policy6
edit <id>

set rsso enable
set fall-through-unathenticated enable

end

IPv6 IPS
IPv6 IPS signature scan can be enabled by interface policy. The user can create an normal IPS sensor and assign
it to the IPv6 interface policy.

config firewall interface-policy6
edit 1

set interface "port1"
set srcaddr6 "all"
set dstaddr6 "all"
set service6 "ALL"
set ips-sensor-status enable
set ips-sensor "all_default"

next
end

Blocking IPv6 packets by extension headers
FortiOS can now block IPv6 packets based on the extension headers, using the CLI syntax:

config firewall ipv6-eh-filter.

The following commands are now available:

l set hop-opt {disable | enable}: Block packets with Hop-by-Hop Options header.
l set dest-opt {disable | enable}: Block packets with Destination Options header.
l set hdopt-type <integer>: Block specific Hop-by-Hop and/or Destination Option types (maximum 7

types, each between 0 and 255).
l set routing {disable | enable}: Block packets with Routing header.
l set routing-type <integar>: Block specific Routing header types (maximum 7 types, each between 0

and 255).
l set fragment {disable | enable}: Block packets with Fragment header.
l set auth {disable | enable}: Block packets with Authentication header.
l set no-next {disable | enable}: Block packets with No Next header.
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IPv6 Denial of Service policies
Denial of Service (DoS) policies can now be configured by going to Policy & Objects > IPv6 DoS Policy. For
more information, refer to the “Interface Policies” section of the FortiOS Handbook Firewall chapter.

Configure hosts in an SNMP v1/2c community to send queries or receive traps
When you add a host to an SNMP v1/2c community you can now decide whether the FortiGate unit will accept
queries from the host or whether the FortiGate unit will send traps to the host. You can also configure the host for
both traps and queries. You can add up to 16 IPv4 hosts and up to 16 IPv6 hosts.

Use the following command to add two hosts to an SNMP community:

config system snmp community
config hosts

edit 1
set ip 172.20.120.1
set host-type query

end
config hosts6

edit 1
set ip 2001:db8:0:2::30
set host-type trap

end

IPv6 PIM sparse mode multicast routing
FortiOS supports PIM sparse mode multicast routing for IPv6 multicast (multicast6) traffic and is compliant with
RFC 4601. You can use the following command to configure IPv6 PIM sparse multicast routing.

config router multicast6
set multicast-routing {enable | disable}

config interface
edit <interface-name>

set hello-interval <1-65535 seconds>
set hello-holdtime <1-65535 seconds>

end
config pim-sm-global
config rp-address

edit <index>
set ipv6-address <ipv6-address>

end

The following diagnose commands for IPv6 PIM sparse mode are also available:

diagnose ipv6 multicast status
diagnose ipv6 multicast vif
diagnose ipv6 multicast mroute
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Chapter 18 - Logging and Reporting

Logging and reporting

Welcome and thank you for selecting Fortinet products for your network protection. This document provides
detailed information that explains how to take advantage of your FortiGate’s ability to log and report activity,
whether you need to monitor network stability, log traffic offsite for security reasons, provide bandwidth usage
reports, or one of many other possible functions.

Logging is an integral component of the FortiGate system. Logging allows you to view the activity and status of
the traffic passing through your network, and monitor for anomalies.

If you notice problems with this document, or have suggestions for improvements, send an email about them to
Fortinet Technical Document at techdoc@fortinet.com.

Before you begin
Before you begin using this guide, please ensure that:

l You have administrative access to the web-based manager and/or CLI.
l The FortiGate unit is integrated into your network.
l The operation mode has been configured.
l The system time, DNS settings, administrator password, and network interfaces have been configured.
l Firmware, FortiGuard Antivirus and FortiGuard Antispam updates are completed.

While using the instructions in this guide, note that administrators are assumed to be super_admin administrators
unless otherwise specified. Some restrictions will apply to other administrators.

How this guide is organized

This document contains information about how to find the right log device for your logging requirements, how to
enable and configure logging to that device, and a detailed explanation of each log type log message.

This FortiOS Handbook chapter contains the following sections:

Logging and reporting overview provides general information about logging. We recommend that you begin with
this chapter as it contains information for both beginners and advanced users as well. It contains an explanation
of log messages, files, and devices, and an overview of the Reporting functions.

Logging and reporting for small networks provides an overview of setting up a small network for logging, with a
look at a possible setup with a backup solution and a customized report.

Logging and reporting for large networks provides an overview of setting up a larger, enterprise-level network,
with configuration of multiple FortiGate units, multiple FortiAnalyzer units as a backup solution, and a sample
procedure for creating a more intensive and broad report to suit the larger network.

Advanced logging provides a series of separate tutorials for possible tasks and procedures an advanced user may
want to undertake with their FortiGate-powered network. It contains explanations of advanced backup, logging,
and report solutions.
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Troubleshooting and logging provides a short overview of how log messages can be used to identify and solve
problems within the network, how to identify and solve logging database issues, and how to solve connection
issues between FortiGate and FortiAnalyzer units.
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What's new in FortiOS 5.6

This section describes new Logging and Reporting features added to FortiOS 5.6.0, 5.6.1, 5.6.3, and 5.6.4.

FortiOS 5.6.4
These features first appeared in FortiOS 5.6.4.

Automatic synchronization of log display location

In previous versions, log display location could differ between Log & Report and FortiView, which could result in
empty log screens if the two were not synchronized. As of 5.6.4, both log viewers automatically pick the best
available log device. A different log device can be manually selected.

As a result, the associated CLI command log gui-display location has been removed.

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Improve FortiAnalyzer storage usage on Log Settings page (409658)

This feature improves FortiAnalyzer storage usage information in log settings to include more detailed per-ADOM
information as follows:

l (1) FAZ ADOM (Name)
Size / Used

l (2) Indexed Logs
Used / Available
Data Policy Days Configured / Actual

l (3) Compressed Logs
Used / Available
Data Policy Days Configured / Actual

Range change for maximum log age (440633)

The value range for "maximum-log-age" under "config log disk setting" has been limited to 0-3650.

New connect and disconnect event logs for FSSO server status change (446263)

Connect and disconnect event logs for FSSO server status changes have been added according to the following:

l When FSSO server status changes from disconnected to connected, record one connected event.
l When FSSO server status changes from connected to disconnected, record one disconnected event and send one

FSSO server disconnected alert email when set.

These logs must be enabled in the CLI.
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Syntax

config alertemail setting
set FSSO-disconnect-logs

Security Fabric audit result logging to FortiGuard (452588)

The CLI now includes an option for the user to enable (by default) or disable FortiGuard security fabric audit result
submission.

If enabled, every time a user runs the Security Fabric audit test on the FortiGate, the audit result will be sent to
FortiGuard. When disabled, no audit data is sent to FortiGuard.

Security Audit categories have been reorganized and renamed to reflect the categories as they are in the security
audit matrix.

Syntax

config system global
set fortiguard-audit-result-submission [enable | disable]

end

Config log disk uploadtime units change (400999)

Instructions for upload time under "config log disk setting" has been clarified by adding the phrase
'daily upload' and mentioning that this is the Hour. The help text also now includes the acceptable range for more
clarity.

Log field extension policy-name and meta-field (455441)

An option to include the policy name field has been added to traffic logs (log-policy-name). Likewise, an
option to add a meta-field tag to all logs has also been added (custom-field and custom-log-fields;
see below). This meta-field could be used for identifying the fortigate sending the logs, for example.

These options can only be enabled in the CLI.

Syntax

config log setting
set log-policy-name [enable | disable]

end
config log custom-field

edit "aaa"
set name "fielda"
set value "111"

next
end
config log setting

set custom-log-fields "aaa"
end

Rename logtime to eventtime (454445)

The "logtime" field in logs has been renamed to "eventtime" to avoid confusion. The logtime is the timestamp that
miglogd receives the message.
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FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

Usability Updates to Reports Page (383684)

The Reports page has been updated in 5.6.1, to include both FortiCloud and Local Reports in a single location.
Configuring of report schedules is also available on this page. The page will display whichever format is enabled,
or allow switching between both if both Local and FortiCloud are in use.

Interface Categories (srcintfrole, etc) added to log data (434188)

In 5.6, logs and FortiView both sort log traffic into two interface categories: "Traffic from LAN/DMZ", and "Traffic
from WAN." For greater compatibility and troubleshooting of FortiAnalyzer and FortiCloud setups, interface
category fields that expose this information have been added to general log data in 5.6.1: srcintfrole and
dstintfrole for better backend control and monitoring.

FortiOS 5.6.0
These features first appeared in FortiOS 5.6.0.

All string values in log messages are enclosed in double quotes (399871)

In previous versions, some string log fields have double quotes and some do not. FortiOS 5.6 adds double-quotes
to all string fields in all log messages.

Some example log messages:

date=2017-01-27 time=10:46:26 logid="0001000014" type="traffic"
subtype="local" level="notice" vd="vd1" srcip=172.16.200.1 srcport=17856
srcintf=unknown-0 dstip=192.168.100.206 dstport=53 dstintf="port1"
sessionid=1461 proto=17 action="accept" policyid=0 dstcountry="Reserved"
srccountry="Reserved" trandisp="noop" service="DNS" app="DNS" duration=180
sentbyte=92 rcvdbyte=0 sentpkt=1 rcvdpkt=0 appcat="unscanned"

date=2017-01-27 time=10:36:34 logid="0107045071" type="event"
subtype="endpoint" level="notice" vd="vd1" logdesc="FortiClient Vulnerability
Scan" scantime=1467851105 fctuid="A8BA0B12DA694E47BA4ADF24F8358E2F"
user="test-user" srcip=192.168.25.26 srcname="test-pc"
srcmac="01:02:03:04:05:06" devtype="Windows PC" vulnid=25894
vulnname="Security Vulnerability CVE-2016-0636 in Oracle JDK"
vulncat="Applications" severity="critical" cveid="CVE-2016-0636"
vendorurl="http://www.oracle.com/technetwork/topics/security/alert-cve-2016-
0636-2949497.html" msg="Endpoint Vulnerbility Scan."

Client and server certificates included in Application control log messages (406203)

When SSL/TLS traffic triggers an application control signature, the application control log messages now include
information about the signatures used by the session. This includes the client certificate issuer, the name in the
server certificate, and the server certificate issuer.
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DNS Logging (401757)

FortiOS logging now includes the Detailed DNS log message type. DNS events were previously recorded as event
logs. In FortiOS 5.6 DNS log messages are a new category that also includes more DNS log messages to provide
additional detail about DNS activity through the FortiGate. You can enable DNS logging from the CLI using the
following command (shown in this example for memory logging):

config log memory filter
set dns enable

end

DNS log messages include details of each DNS query and response. DNS log messages are recorded for all
DNS traffic though the FortiGate and originated by the FortiGate.

The detailed DNS logs can be used for low-impact security investigation. Most network activity involves DNS
activity of some kinds. Analyzing DNS logs can provide a lot of details about the activity on your network without
using flow or proxy-based resource intensive techniques.

Added Policy Comment logging option (387865)

As an alternative to custom log fields, the functionality has been added to log a policy's comment field in all traffic
log files that use that policy, in order to sort/isolate logs effectively with larger deployments and VDOMs. The
feature is disabled by default.

config log setting
set log policy comment [enable/disable]

FortiAnalyzer encryption option name change (399191)

For clarity, and because the default options for config log fortianalyzer setting have now changed,
the option default has now been changed to high-medium in the following CLI commands:

config log fortianalyzer setting
set enc-algorithm [high/high-medium/low]

config log fortinalyzer override-setting
set enc-algorithm [high/high-medium/low]

config log fortiguard setting
set enc-algorithm [high/high-medium/low]

config log fortiguard override-setting
set enc-algorithm [high/high-medium/low]
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Logging and reporting overview

Logging and reporting in FortiOS can help you in determining what is happening on your network, as well as
informing you of certain network activity, such as detection of a virus or IPsec VPN tunnel errors. Logging and
reporting go hand in hand, and can become a valuable tool for information as well as helping to show others the
activity that is happening on the network.

This section explains logging and reporting features that are available in FortiOS, and how they can be used to
help you manage or troubleshoot issues. This includes how the FortiGate unit records logs, what a log message
is, and what the log database is.

What is logging?
Logging records the traffic passing through the FortiGate unit to your network and what action the FortiGate unit
took during its scanning process of the traffic. This recorded information is called a log message.

After a log message is recorded, it is stored within a log file which is then stored on a log device. A log device is a
central storage location for log messages. The FortiGate unit supports several log devices, such as FortiAnalyzer
units, the FortiCloud service, and Syslog servers. A FortiGate unit’s system memory and local disk can also be
configured to store logs, and because of this, are also considered log devices.

You must subscribe to FortiCloud before you will be able to configure the FortiGate
unit to send logs to a FortiCloud server.

When the recorded activity needs to be read in a more human way, the FortiGate unit can generate a Report. A
report gathers all the log information that is needed for the report, and presents it in a graphical format, with
customizable design and automatically generated charts. Reports can be used to present a graphical
representation of what is going on in the network. Reports can also be generated on a FortiAnalyzer unit; if you
want to generate reports on a FortiAnalyzer, see the FortiAnalyzer documentation to help you create and
generate those reports.

How the FortiGate unit records log messages

The FortiGate unit records log messages in a specific order, storing them on a log device. The order of how the
FortiGate unit records log messages is as follows:

1. Incoming traffic is scanned.
2. During the scanning process, the FortiGate unit performs necessary actions, and simultaneously records the

actions and results.
3. Log messages are sent to the log device.

Example: How the FortiGate unit records a DLP event

1. The FortiGate unit receives incoming traffic and scans for any matches associated within its firewall policies
containing a DLP sensor.

2. Amatch is found; the DLP sensor, dlp_sensor, had a rule within it called All-HTTPwith the action Exempt applied
to the rule. The sensor also has Enable Logging selected, which indicates to the FortiGate unit that the activity
should be recorded and placed in the DLP log file.
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3. The FortiGate unit exempts the match, and places the recorded activity (the log message) within the DLP log file.
4. According to the log settings that were configured, logs are stored on the FortiGate unit’s local hard drive. The

FortiGate unit places the DLP log file on the local hard drive.

FortiOS features available for logging
Logs record FortiGate activity, providing detailed information about what is happening on your network. This
recorded activity is found in log files, which are stored on a log device. However, logging FortiGate activity
requires configuring certain settings so that the FortiGate unit can record the activity. These settings are often
referred to as log settings, and are found in most security profiles, but also in Log & Report > Log Settings.

Log settings provide the information that the FortiGate unit needs so that it knows what activities to record. This
topic explains what activity each log file records, as well as additional information about the log file, which will
help you determine what FortiGate activity the FortiGate unit should record.

Traffic

Traffic logs record the traffic that is flowing through your FortiGate unit. Since traffic needs firewall policies to
properly flow through the unit, this type of logging is also referred to as firewall policy logging. Firewall policies
control all traffic that attempts to pass through the FortiGate unit, between FortiGate interfaces, zones and VLAN
sub-interfaces.

Logging traffic works in the following way:

l firewall policy has logging enabled on it (Log Allowed Traffic)
l packet comes into an inbound interface
l a possible log packet is sent regarding a match in the firewall policy, such as a URL filter
l traffic log packet is sent, per firewall policy
l packet passes and is sent out an interface

Traffic log messages are stored in the traffic log file. Traffic logs can be stored any log device, even system
memory.

All security profile-related logs are now tracked within the Traffic logs, as of FortiOS 5.0, so all forward traffic can
be searched in one place, such as if you are looking to see all activity from a particular address, security feature or
traffic. Security profile logs are still tracked separately in the Security Log section, which only appears when logs
exist.

If you have enabled and configured WAN Optimization, you can enable logging of this activity in the CLI using the
config wanopt setting command. These logs contain information about WAN Optimization activity and
are found in the traffic log file. When configuring logging of this activity, you must also enable logging within the
security policy itself, so that the activity is properly recorded.

Sniffer

The Sniffer log records all traffic that passes through a particular interface that has been configured to act as a
One-Armed Sniffer, so it can be examined separately from the rest of the Traffic logs.

Other Traffic

The traffic log also records interface traffic logging, which is referred to as Other Traffic. Other Traffic is enabled
only in the CLI. When enabled, the FortiGate unit records traffic activity on interfaces as well as firewall policies.
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Logging Other Traffic puts a significant system load on the FortiGate unit and should be used only when
necessary.

Logging other traffic works in the following way:

l firewall policy has logging enabled on it (Log Allowed Traffic) and other-traffic
l packet comes into an interface
l interface log packet is sent to the traffic log that is enabled on that particular interface
l possible log packet is sent regarding a match in the firewall policy, such as URL filter
l interface log packet is sent to the traffic log if enabled on that particular interface
l packet passes and is sent out an interface
l interface log packet is sent to traffic (if enabled) on that particular interface

Event

The event log records administration management as well as FortiGate system activity, such as when a
configuration has changed, admin login, or high availability (HA) events occur. Event logs are an important log file
to record because they record FortiGate system activity, which provides valuable information about how your
FortiGate unit is performing.

Event logs help you in the following ways:

l keeping track of configuration setting changes
l IPsec negotiation, SSL VPN and tunnel activity
l quarantine events, such as banned users
l system performance
l HA events and alerts
l firewall authentication events
l wireless events on models with WiFi capabilities
l activities concerning modem and internet protocols L2TP, PPP and PPPoE
l VIP activities
l AMC disk’s bypass mode
l VoIP activities that include SIP and SCCP protocols.

As of 5.4, every 'execute' CLI command now generates an 'audit' event log, allowing you to track configuration
changes. You can enable/disable this feature in the CLI:

config system global
set cli-audit-log [enable|disable]

end

The FortiGate unit records event logs only when events are enabled.

Traffic Shaping

Traffic shaping, per-IP traffic shaping and reverse direction traffic shaping settings can be applied to a firewall
policy, appearing within the traffic log messages.

By enabling this feature, you can see what traffic shaping, per-IP traffic shaping and reverse direction traffic
shaping settings are being used.
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Data Leak Prevention

Data Leak Prevention logs, or DLP logs, provide valuable information about the sensitive data trying to get
through to your network as well as any unwanted data trying to get into your network. The DLP rules within a DLP
sensor can log the following traffic types:

l email (SMTP, POP3 or IMAP; if SSL content SMTPS, POP3S, and IMAPS)
l HTTP
l HTTPS
l FTP
l NNTP
l IM

A DLP sensor must have log settings enabled for each DLP rule and compound rule, as well as applied to a
firewall policy so that the FortiGate unit records this type of activity. A DLP sensor can also contain archiving
options, which these logs are then archived to the log device.

NAC Quarantine

Within the DLP sensor, there is an option for enabling NAC Quarantine. The NAC Quarantine option allows the
FortiGate unit to record details of DLP operation that involve the ban and quarantine actions, and sends these to
the event log file. The NAC Quarantine option must also be enabled within the Event Log settings. When
enabling NAC quarantine within a DLP Sensor, you must enable this in the CLI because it is a CLI-only
command.

Media Access Control (MAC) Address

MAC address logs provide information about MAC addresses that the FortiGate unit sees on the network as well
as those removed from the network. These log messages are stored in the event log (as subtype network; you
can view these log messages in Log & Report > System Events) and are, by default, disabled in the CLI. You
can enable logging MAC addresses using the following command syntax:

config log setting
set neighbor-event enable

end

When enabled, a new log message is recorded every time a MAC address entry is added to the ARP table, and
also when a MAC address is removed as well. A MAC address log message is also recorded when MAC
addresses are connected to the local switch, or from a FortiAP or FortiSwitch unit.

Application control

Application control logs provide detailed information about the traffic that internet applications such as Skype are
generating. The application control feature controls the flow of traffic from a specific application, and the
FortiGate unit examines this traffic for signatures that the application generates.

The log messages that are recorded provide information such as the type of application being used (such as P2P
software), and what type of action the FortiGate unit took. These log messages can also help you to determine
the top ten applications that are being used on your network. This feature is called application control monitoring
and you can view the information from a widget on the Executive Summary page.
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The application control list that is used must have logging enabled within the list, as well as logging enabled
within each application entry. Each application entry can also have packet logging enabled. Packet logging for
application control records the packet when an application type is identified, similar to IPS packet logging.

Logging of application control activity can only be recorded when an application control list is applied to a firewall
policy, regardless of whether or not logging is enabled within the application control list.

Antivirus

Antivirus logs are recorded when, during the antivirus scanning process, the FortiGate unit finds a match within
the antivirus profile, which includes the presence of a virus or grayware signature. Antivirus logs provide a way to
understand what viruses are trying to get in, as well as additional information about the virus itself, without having
to go to the FortiGuard Center and do a search for the detected virus. The link is provided within the log message
itself.

These logs provide valuable information such as:

l the name of the detected virus
l the name of the oversized file or infected file
l the action the FortiGate unit took, for example, a file was blocked
l URL link to the FortiGuard Center which gives detailed information about the virus itself

The antivirus profile must have log settings enabled within it so that the FortiGate unit can record this activity, as
well as having the antivirus profile applied to a firewall policy.

Web Filter

Web filter logs record HTTP traffic activity. These log messages provide valuable and detailed information about
this particular traffic activity on your network. Web filtering activity is important to log because it can inform you
about:

l what types of web sites employees are accessing
l users attempting to access banned web sites and how often this occurs
l network congestion due to employees accessing the Internet at the same time
l web-based threats resulting from users visiting non-business-related web sites

Web Filter logs are an effective tool to help you determine if you need to update your web filtering settings within
a web filter profile due to unforeseen threats or network congestion. These logs also inform you about web
filtering quotas that have been configured for filtering HTTP traffic.

You must configure logging settings within the web filter profile and apply the filter to a firewall policy so that the
FortiGate unit can record the activity.

IPS (attack)

IPS logs, also referred to as attack logs, record attacks that occurred against your network. Attack logs contain
detailed information about whether the FortiGate unit protected the network using anomaly-based defense
settings or signature-based defense settings, as well as what the attack was.

The IPS or attack log file is especially useful because the log messages that are recorded contain a link to the
FortiGuard Center, where you can find more information about the attack. This is similar to antivirus logs, where
a link to the FortiGuard Center is provided as well that informs you of the virus that was detected by the FortiGate
unit.
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An IPS sensor with log settings enabled must be applied to a firewall policy so that the FortiGate unit can record
the activity.

Packet logs

When you enable packet logging within an IPS signature override or filter, the FortiGate unit examines network
packets, and if a match is found, saves them to the attack log. Packet logging is designed to be used as a
diagnostic tool that can focus on a narrow scope of diagnostics, rather than a log that informs you of what is
occurring on your network.

You should use caution when enabling packet logging, especially within IPS filters. Filter configuration that
contains thousands of signatures could potentially cause a flood of saved packets, which would take up a lot of
storage space on the log device. It would also take a great deal of time to sort through all the log messages, as
well as consume considerable system resources to process.

You can archive packets, but you must enable this option on the Log Settings page. If your log configuration
includes multiple FortiAnalyzer units, packet logs are only sent to the primary (first) FortiAnalyzer unit. Sending
packet logs to the other FortiAnalyzer units is not supported.

Email filter

Email filter logs, also referred to as spam filter logs, record information regarding the content within email
messages. For example, within an email filter profile, a match is found that finds the email message to be
considered spam.

Email filter logs are recorded when the FortiGate unit finds a match within the email filter profile and logging
settings are enabled within the profile.

If you are using a Banned Words List for email filtering, note that the filter pattern
number is only recorded when the source email address contains a banned word.

Archives (DLP)

Recording DLP logs for network use is called DLP archiving. The DLP engine examines email, FTP, IM, NNTP,
and web traffic. Archived logs are usually saved for historical use and can be accessed at any time. IPS packet
logs can also be archived, within the Log Settings page.

You can start with the two default DLP sensors that have been configured specifically for archiving log data,
Content_Archive and Content_Summary. They are available in Security Profiles > Data Leak Prevention.
Content_Archive provides full content archiving, while Content_Summary provides summary archiving. For more
information about how to configure DLP sensors, see the Security Features chapter of the FortiOS Handbook.

You must enable the archiving to record log archives. Logs are not archived unless enabled, regardless of
whether or not the DLP sensor for archiving is applied to the firewall policy.

Network scan

Network scan logs are recorded when a scheduled scan of the network occurs. These log messages provide
detailed information about the network’s vulnerabilities regarding software, as well as the discovery of any further
vulnerabilities.

A scheduled scan must be configured and logging enabled within the Event Log settings, for the FortiGate unit to
record these log messages.
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Log messages
Log messages are recorded by the FortiGate unit, giving you detailed information about the network activity.
Each log message has a unique number that helps identify it, as well as containing fields; these fields, often
called log fields, organize the information so that it can be easily extracted for reports.

These log fields are organized in such a way that they form two groups: the first group, made up of the log fields
that come first, is called the log header. The log header contains general information, such as the unique log
identification and date and time that indicates when the activity was recorded. The log body is the second group,
and contains all the other information about the activity. There are no two log message bodies that are alike,
however, there may be fields common to most log bodies, such as the srcintf or identidix log fields.

The log header also contains information about the log priority level which is indicated in the level field. The
priority level indicates the immediacy and the possible repercussions of the logged action. For example, if the
field contains ‘alert’, you need to take immediate action with regards to what occurred. There are six log priority
levels.

The log severity level is the level at and above which the FortiGate unit records logs. The log severity level is
defined by you when configuring the logging location. The FortiGate unit will log all messages at and above the
priority level you select. For example, if you select Error, the unit will log only Error, Critical, Alert, and Emergency
level messages.

Log priority levels

Levels Description

0 - Emergency The system has become unstable.

1 - Alert Immediate action is required.

2 - Critical Functionality is affected.

3 - Error An error condition exists and functionality could be affected.

4 - Warning Functionality could be affected.

5 - Notification Information about normal events.

6 - Information General information about system operations.

The Debug priority level, not shown above, is rarely used. It is the lowest log priority level and usually contains
some firmware status information that is useful when the FortiGate unit is not functioning properly.

Example log header fields

Log header

date=(2010-08-03) The year, month and day of when the event occurred in yyyy-mm-dd
format.
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Log header

time=(12:55:06) The hour, minute and second of when the event occurred in the format
hh:mm:ss.

log_id=(2457752353) A five or ten-digit unique identification number. The number represents that
log message and is unique to that log message. This ten-digit number
helps to identify the log message.

type=(dlp) The section of system where the event occurred.

subtype=(dlp) The subtype category of the log message.

level=(notice) The priority level of the event. See the table above.

vd=(root) The name of the virtual domain where the action/event occurred in. If no
virtual domains exist, this field always contains root.

Example log body fields

Log body

policyid=(1) The ID number of the firewall policy that applies to the session or packet.
Any policy that is automatically added by the FortiGate will have an index
number of zero.

identidx=(0)

The identity-based policy identification number. This field displays zero if
the firewall policy does not use an identity-based policy; otherwise, it
displays the number of the identity-based policy entry that the traffic
matched. This number is not globally unique, it is only locally unique within
a given firewall policy.

sessionid=(311) The serial number of the firewall session of which the event happened.

srcip=(10.10.10.1) The source IP address.

srcport=(1190) The source port number.

srcintf=(internal) The source interface name.

dstip=(192.168.1.122) The destination IP address.

dstport=(80) The destination port number.

dstintf=(wan1) The destination interface name.

service=(https) The IP network service that applies to the session or packet. The services
displayed correspond to the services configured in the firewall policy.

status=(detected) The action the FortiGate unit took.
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Log body

hostname=(example.com) The home page of the web site.

url=(/image/trees_pine_
forest/)

The URL address of the web page that the user was viewing.

msg=(data leak detected
(Data Leak Prevention Rule
matched)

Explains the FortiGate activity that was recorded. In this example, the data
leak that was detected matched the rule, All-HTTP, in the DLP sensor.

rulename=(All-HTTP) The name of the DLP rule within the DLP sensor.

action=(log-only)
The action that was specified within the rule. In some rules within sensors,
you can specify content archiving. If no action type is specified, this field
display log-only.

severity=(1) The level of severity for that specific rule.

Logs from other devices, such as the FortiAnalyzer unit and Syslog server, contain a slightly different log header.
For example, when viewing FortiGate log messages on the FortiAnalyzer unit, the log header contains the
following log fields when viewed in the Raw format:

itime=1302788921 date=20110401 time=09:04:23 devname=FG50BH3G09601792 device_
id=FG50BH3G09601792 log_id=0100022901 type=event subtype=system level=notice vd=root

The log body contains the rest of the information of the log message, and this information is unique to the log
message itself.

For detailed information on all log messages, see the FortiGate LogMessage Reference.

Explanation of a debug log message

Debug log messages are only generated if the log severity level is set to Debug. The Debug severity level is the
lowest log severity level and is rarely used. This severity level usually contains some firmware status information
that is useful when the FortiGate unit is not functioning properly. Debug log messages are generated by all types
of FortiGate features.

The following is an example of a debug log message:

date=2010-01-25 time=17:25:54 logid=9300000000 type=webfilter subtype=urlfilter
level=debug msg=“found in cache”

Example of a Debug log message

Debug log

date=(2010-01-25) The year, month and day of when the event occurred in the format yyyy-
mm-dd.

time=(17:25:54) The hour, minute and second of when the event occurred in the format
hh:mm:ss.
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Debug log

logid=(93000000000) A ten-digit unique identification number. The number represents that log
message and is unique to that log message. This ten-digit number helps to
identify the log message.

type=(webfilter) The section of system where the event occurred. There are eleven log types
in FortiOS 4.0.

subtype=(urlfilter) The subtype of the log message. This represents a policy applied to the
FortiGate feature in the firewall policy.

level=(debug) The priority level of the event. There are six priority levels to specify.

msg=(“found in cache”) Explains the activity or event that the FortiGate unit recorded.

Viewing log messages and archives

Depending on the log device, you may be able to view logs within the web-based manager or CLI on the
FortiGate unit. If you have configured a FortiAnalyzer unit, local hard disk, or system memory, you can view log
messages from within the web-based manager or CLI. If you have configured either a Syslog or WebTrends
server, you will not be able to view log messages from the web-based manager or CLI. There is also no support
for viewing log messages stored on a FortiCloud server, from the FortiGate unit’s web-based manager or CLI.

You do not have to view log messages from only the web-based manager. You can view log messages from the
CLI as well, using the execute log display command. This command allows you to see specific log
messages that you already configured within the execute log filter command. The execute log
filter command configures what log messages you will see, how many log messages you can view at one
time (a maximum of 1000 lines of log messages), and the type of log messages you can view. For more
information about viewing log messages in the CLI, see "Viewing logs from the CLI".

There are two log viewing options in FortiOS: Format and Raw. The Raw format displays logs as they appear
within the log file. You can view log messages in the Raw format using the CLI or a text editor, such as Notepad.
Format is in a more human-readable format, and you can easily filter information when viewing log messages this
way. The Format view is what you see when viewing logs in the web-based manager.

When you download the log messages from within the log message page (for example, Log & Report >
Forward Traffic), you are downloading log messages in the Raw format.

Viewing log messages in detail

From any log page, you can view detailed information about the log message in the log viewer table, located (by
default) at the bottom of the page. Each page contains this log viewer table. The Log Viewer Table can contain
the Archive tab, which allows you to see the archived version of the log message. The Archive tab only displays
the archived log’s details if archiving is enabled and logs are being archived by the FortiGate unit, but archived
logs will also be recorded when using a FortiAnalyzer unit or the FortiCloud service.

When you are viewing traffic log messages, some of the categories (such as ‘Application Name’) have entries that
can be selected to open a dialog box containing FortiGuard information about the entry. From within the dialog
box, you can select the Reference link and go directly to the corresponding FortiGuard page, which contains
additional information.
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Viewing logs in Raw format allows you to view all log fields at once, as well as have a log file available regardless
of whether you are archiving logs or not. You download the log file by selecting Download Log. The log file is
named in the following format: <log_type><log_location><log_date/time>.<log_number>.log. For example,
SystemEventLog-disk-2012-09-19T12_13_46.933949.log, which is an event log. The time period is the day and
month of when the log was downloaded, not the time period of the log messages within the file itself.

Quarantine

Within the Log & Report menu, you can view detailed information about each quarantined file. The information
can either be sorted or filtered, depending on what you want to view.

You must enable quarantine settings within an antivirus profile and the destination must be configured in the CLI
using the config antivirus quarantine command. The destination can be either a FortiAnalyzer unit or
local disk.

Sort the files by file name, date, service, status, duplicate count (DC), or time to live (TTL). Filter the list to view
only quarantined files with a specific status or from a specific service.

The file quarantine list displays the following information about each quarantined file.

Quarantine page

Lists all files that are considered quarantined by the unit. On this page you can filter information so that only
specific files are displayed on the page.

GUI Item Description

Source Either FortiAnalyzer or Local Disk, depending where you configure to
quarantined files to be stored.

Sort by Sort the list. Choose from: Status, Service, File Name, Date, TTL, or
Duplicate Count. Select Apply to complete the sort.

Filter Filter the list. Choose either Status (infected, blocked, or heuristics) or
Service (IMAP, POP3, SMTP, FTP, HTTP, MM1, MM3, MM4, MM7, IM,
or NNTP). Select Apply to complete the filtering. Heuristics mode is
configurable through the CLI only.

If your unit supports SSL content scanning and inspection Service can also
be IMAPS, POP3S, SMTPS, or HTTPS. For more information, see the
Security Features chapter of the FortiOS Handbook.

Apply Select to apply the sorting and filtering selections to the list of quarantined
files.

Delete Select to delete the selected files.

Page Controls Use the controls to page through the list.
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GUI Item Description

Remove All Entries Removes all quarantined files from the local hard disk.

This icon only appears when the files are quarantined to the hard disk.

File Name

The file name of the quarantined file. When a file is quarantined, all spaces
are removed from the file name, and a 32-bit checksum is performed on the
file. The checksum appears in the replacement message but not in the
quarantined file. The file is stored on the FortiGate hard disk with the
following naming convention:

<32bit_CRC>.<processed_filename>

For example, a file named Over Size.exe is stored as
3fc155d2.oversize.exe.

Date The date and time the file was quarantined, in the format dd/mm/yyyy
hh:mm. This value indicates the time that the first file was quarantined if
duplicates are quarantined.

Service
The service from which the file was quarantined (HTTP, FTP, IMAP, POP3,
SMTP, MM1, MM3, MM4, MM7, IM, NNTP, IMAPS, POP3S, SMTPS, or
HTTPS).

Status The reason the file was quarantined: infected, heuristics, or blocked.

Status Description Specific information related to the status, for example, “File is infected with
“W32/Klez.h”” or “File was stopped by file block pattern.”

DC Duplicate count. A count of how many duplicates of the same file were
quarantined. A rapidly increasing number can indicate a virus outbreak.

TTL

Time to live in the format hh:mm. When the TTL elapses, the FortiGate
unit labels the file as EXP under the TTL heading. In the case of duplicate
files, each duplicate found refreshes the TTL.

The TTL information is not available if the files are quarantined on a
FortiAnalyzer unit.

Upload status Y indicates the file has been uploaded to Fortinet for analysis, N indicates
the file has not been uploaded.

This option is available only if the FortiGate unit has a local hard disk.

Download
Select to download the corresponding file in its original format.

This option is available only if the FortiGate unit has a local hard disk.

Submit Select to upload a suspicious file to Fortinet for analysis.

This option is available only if the FortiGate unit has a local hard disk.
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Customizing the display of log messages on the web-based manager

Customizing log messages on the web-based manager allows you to remove or add columns from the page and
filter the information that appears. For example, you can view only log messages that appeared on December 4,
between the hours of 8:00 and 8:30 am.

1. Select the submenu in Log & Report in which you want to customize the display of log messages, such as Log
& Report > Forward Traffic.

2. Right click on the title bar at the top of any column, and uncheck a column title such asDate/Time to remove it
from the interface. Check other columns to add them to the interface. When you are finished, click outside the
menu and the page will refresh with the new column settings in place.

3. Choose a column you’d like to filter, and select the funnel icon next to the title of the column. For example, select
the funnel in the Src (Source) column. In the text field, enter the source IP address 1.1.1.1 and then select the
check box beside NOT.
This filters out the all log messages that have the 1.1.1.1 source IP address in the source IP log field, such as the
ones generated when running log tests in the CLI.

4. Select OK to save the customize settings, and then view the log messages on the page.
Log messages that originate from the 1.1.1.1 source address will no longer appear in the list.

How to download log messages and view them from on a computer

After recording some activity, you can download log messages to view them from a computer. This is can be very
useful when in a remote location, or if you want to view log messages at your convenience, or to view packet logs
or traffic logs.

1. In Log & Report, select the submenu that you want to download log messages from.
For example, Log & Report > Forward Traffic.

2. Select the Download Log option and save the log file to your computer.
The log file will be downloaded like any other file. Log file names contain their log type and date in the name, so it
is recommended to create a folder in which to archive your log messages, as they can be sorted easily.

3. Open a text editor such as Notepad, open the log file, and then scroll to view all the log messages.
You can easily search or scroll through the logs to see the information that is available.

Log files and types
As the log messages are being recorded, log messages are also being put into different log files. The log file
contains the log messages that belong to that log type, for example, traffic log messages are put in the traffic log
file.

When downloading the log file from within Log & Report, the file name indicates the log type and the device on
which it is stored, as well as the date, time, and a unique id for that log.

This name is in the format <logtype> - <logdevice> - <date> T <time> . <id>.log.

For example, AntiVirusLog-disk-2012-09-13T11_07_57.922495.log.

Below, each of the different log files are explained. Traffic and Event logs come in multiple types, but all contain
the base type such as ‘Event’ in the filename.
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Log Types based on network traffic

Log Type Description

Traffic The traffic logs records all traffic to and through the FortiGate interface.
Different categories monitor different kinds of traffic, whether it be forward,
local, or sniffer.

Event

The event logs record management and activity events within the device in
particular areas: System, Router, VPN, User, Endpoint, HA, WAN
Opt./Cache, and WiFi. For example, when an administrator logs in or logs
out of the web-based manager, it is logged both in System and in User
events.

Antivirus The antivirus log records virus incidents in Web, FTP, and email traffic.

Web Filter The web filter log records HTTP FortiGate log rating errors including web
content blocking actions that the FortiGate unit performs.

Application Control The application log records application usage, monitoring or blocking as
configured in the security profiles.

Intrusion The intrusion log records attacks that are detected and prevented by the
FortiGate unit.

Email Filter The email filter log records blocking of email address patterns and content
in SMTP, IMAP, and POP3 traffic.

Vulnerability Scan The Vulnerability Scan (Netscan) log records vulnerabilities found during
the scanning of the network.

Data Leak Prevention The Data Leak Prevention log records log data that is considered sensitive
and that should not be made public. This log also records data that a
company does not want entering their network.

VoIP The VoIP log records VoIP traffic and messages. It only appears if VoIP is
enabled on the Administrator Settings page.

Log database and datasets
The log database, also known as the SQL log database, is used to store logs on FortiGate units that have a built-
in hard disk. The log database uses Structured Query Lanaguage (SQL), specifically it uses SQLite which is an
embedded Relational Database Management System (RDBMS).

If you have disabled SQL logging and have factory defaults on the FortiGate unit, and
then you upgrade the firmware, the upgrade will automatically disable SQL logging.
When this occurs, you must re-enable SQL logging manually.

The FortiGate unit creates a database table for each log type, when log data is recorded. If the FortiGate unit is
not recording log data, it does not create log tables for that device.
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If you want to view the size of the database, as well as the log database table entries, use the get report
sql status command. This command displays the amount of free space that is available as well as the first
and last log database entry time and date.

The output of the get report sql status command contains information similar to the following:

Database size: 294912
Free size in database: 0
Database Page Size: 8192
Entry number:
Event: 49
Traffic: 370
Attack: 2
AntiVirus: 4
WebFilter: 254
AntiSpam: 2
Netscan: 18
Total: 699
First entry time: 2012-09-10 11:41:02
Last entry time: 2012-09-13 02:59:59

The log database is not only used to store logs, but also used to extract the information for reports. Reports are
built from datasets, which are SQL statements that tell the FortiGate unit how to extract the information from the
database. You can create your own datasets; however, SQL knowledge is required. Default datasets are
available for reports.

Notifications about network activity

Alert email messages provide notification about activities or events logged. These email messages also provide
notification about log severities that are recorded, such as a critical or emergency.

You can send alert email messages to up to three email addresses. Alert messages are also logged and can be
viewed from the Event Log menu, in the System Event log file.

You can use the alert email feature to monitor logs for log messages, and to send email notification about a
specific activity or event logged. For example, if you require notification about administrators logging in and out,
you can configure an alert email that is sent whenever an administrator logs in and out. You can also base alert
email messages on the severity levels of the logs.

Before configuring alert email, you must configure at least one DNS server if you are configuring with an Fully
Qualified Domain Server (FQDN). The FortiGate unit uses the SMTP server name to connect to the mail server,
and must look up this name on your DNS server. You can also specify an IP address.

The default minimum log severity level is Alert. If the FortiGate unit collects more than
one log message before an interval is reached, the FortiGate unit combines the
messages and sends out one alert email.

How to configure email notifications

The following explains how to configure an alert email notification for IPsec tunnel errors, firewall authentication
failure, configuration changes and FortiGuard license expiry.

1. In System > Advanced, under Email Service, configure the SMTP server.
The SMTP server settings allow the FortiGate unit to know exactly where the email will be sent from, as well as
who to send it to. The SMTP server must be a server that does not support SSL/TLS connections; if the SMTP
server does, the alert email configuration will not work. The FortiGate unit does not currently support SSL/TLS
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connections for SMTP servers.
2. In Log & Report > Alert E-mail, enter the source email in the Email From field, and up to three target

addresses in the Email To fields.
3. Below the email entry, you can configure the email responses. By default, the Send alert email for the

following is enabled. Select the check boxes beside IPsec tunnel errors, Configuration changes and
Firewall authentication failure.
These alerts will be sent to the email address specified when the trigger occurs. For example, a user attempts to
connect to the branch office of the company but cannot; the FortiGate unit detects an IPsec tunnel error, records
the event, and then sends the notice to the email address specified in the SMTP server settings.

4. Select FortiGuard license expiry time: and then enter 10 so that the email notification will be sent ten days
prior to the FortiGuard license expiration.
You can choose up to 100 days prior to when the license will expire. The default time is 15 days. By using this alert
email notification, you can easily know when to send an re-registration request long before the expiry.

Log devices
The FortiGate unit supports a variety of log devices, including the FortiCloud service and FortiAnalyzer units. This
provides greater flexibility not only when choosing a log device, but also when your logging requirements need
updating.

When you have developed a plan that meets your logging needs and requirements, you need to select the log
device that is appropriate for that plan. A log device must be able to store all the logs you need, and if you require
archiving those logs, you must consider what log devices support this option.

During this process of deciding what log device meets your needs and requirements, you must also figure out how
to provide a backup solution in the event the log device that the FortiGate unit is sending logs to has become
unavailable. A backup solution should be an important part of your log setup because it helps you to maintain all
logs and prevents lost logs, or logs that are not sent to the log device. For example, a daily backup of log files to
the FortiAnalyzer unit occurs at 5 pm.

Log devices provide a central location for storing logs recorded by the FortiGate unit. The following are log
devices that the FortiGate unit supports:

l FortiGate system memory
l Hard disk or AMC
l SQL database (for FortiGate units that have a hard disk)
l FortiAnalyzer unit
l FortiCloud service
l Syslog server

These log devices, except for the FortiGate system memory and local hard disk, can also be used as a backup
solution. For example, you can configure logging to the FortiGate unit’s local disk, but also configure logging to a
FortiCloud server and archive logs to both the FortiCloud server and a FortiAnalyzer unit.

If you are formatting a disk that contains more than just logs, all information on the
disk will be lost.
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FortiGate unit’s system memory and hard disk

The FortiGate unit’s system memory and hard disk can store all log types, including log archives and traffic logs.
Traffic logs and log archives are larger files, and need a lot of room when being logged by the FortiGate unit.

When the system memory is full, the FortiGate unit overwrites the oldest messages, and all log messages stored
in memory are cleared when the FortiGate unit restarts. By default, logging to memory is enabled. This means
that most of the time you will only need to modify the default settings to your network logging requirements. Real-
time logging occurs whenever memory logging is enabled, and is enabled by default. Real-time logging means
that the activity is being recorded as it happens.

All FortiGate units 100D and larger are capable of disk logging, but it is disabled by default, as it is not
recommended. For flash memory-based units, constant rewrites to flash drives can reduce the lifetime and
efficiency of the memory. For hard-disk units, it can affect performance under heavy strain. Therefore, disk
logging must be manually enabled in the CLI under config log disk setting to appear in the interface at
all.

Models without a hard disk are not recommended for disk logging. For all units, disk
logging must be enabled in the CLI. For some low-end and older models, disk logging
is unavailable. Check a product’s Feature Matrix for more information. In either case,
Fortinet recommends using either a FortiAnalyzer unit or the FortiCloud service.

Local disk or memory logging is not required for you to configure logging to a FortiAnalyzer unit.

If you are registered with the FortiCloud service, your unit will log both locally and to the service by default. In
order to configure the rate and time of uploads to the service, you must register a contract account for the
FortiCloud service, which will also grant you additional space.

FortiAnalyzer unit

The FortiAnalyzer unit can log all FortiGate features, which includes log archives. You can also configure the
FortiGate unit to upload logs to the FortiAnalyzer unit at a scheduled time.

Encryption of the logs is supported by default and logs are sent using SSL VPN. When the FortiAnalyzer and
FortiGate units have SSL encryption, both must choose a setting for the enc-algorithm command (CLI) for
encryption to take place. By default, this is enabled and the default setting is a SSL communication with high and
medium encryption algorithms. The setting that you choose must be the same for both.

FortiGate units can support logging to multiple FortiAnalyzer units. This logging solution is a backup redundancy
solution, since logs are sent to all three units and whenever one of the FortiAnalyzer units fails, the others still
carry on storing logs.

If you are using evaluation software FortiGate and FortiAnalyzer-VM images, you will only be able to use low-
level encryption.

The FortiGate unit can also connect to a FortiAnalyzer unit using Automatic Discovery. Automatic Discovery is a
method of establishing a connection to a FortiAnalyzer unit by using the FortiGate unit to find a FortiAnalyzer unit
on the network. The Fortinet Discovery Protocol (FDP) is used to located the FortiAnalyzer unit. Both the
FortiGate and FortiAnalyzer units must be on the same subnet to use FDP, and they must also be able to connect
using UDP.

When you enable automatic discovery in the CLI, the FortiGate unit uses HELLO packets to locate any
FortiAnalyzer units that are available on the network within the same subnet. When the FortiGate unit discovers a
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FortiAnalyzer unit, the FortiGate unit automatically enables logging to the FortiAnalyzer unit and begins sending
log data.

Syslog server

A Syslog server is a remote computer running syslog software. Syslog is a standard for forwarding log messages
in an IP network, and can be used when considering a log backup solution for your network logging requirements.
Logs that are generated in real-time are sent to the syslog server in real time with no queueing, so it can be an
ideal solution for comprehensive logging, or collecting logs for later systematic analysis.

FortiGate units support the reliable syslog feature, which is based on RFC 3195. Reliable syslog logging uses
TCP, which ensures that connections are set up, including that packets are transmitted.

There are several profiles available for reliable syslog, but only the RAW profile is currently supported on the
FortiGate units. The RAW profile is designed to provide a high-performance, low-impact footprint using
essentially the same format as the existing UDP-based syslog service. The reliable syslog feature is available on
FortiGate units running FortiOS 4.0 MR1 and higher.

When enabling the reliable syslog (available only in the CLI), TCP is used. The feature is disabled by default, and
when enabled, the FortiGate unit automatically changes the port number to TCP 601. This is based on RFC
3195. The default port for syslog is port 514.

If you are using the local hard disk on a device for WAN Optimization, it will not
prevent you from logging to remote FortiAnalyzer devices or Syslog servers. Some
models have two hard disks, allowing both local logging and Wan Opt.

If you have Virtual Domains configured, each VDOM may only be assigned one
FortiAnalyzer device and one Syslog server, by overriding the global configuration. The
root VDOM is not limited in this way.

How to choose a log device for your network topology

When planning the log requirements, you must also consider your network’s topology and whether archiving is
required, such as if there is a legal requirement to keep a historical record of network activity. The following
explains what steps to take when choosing a log device for your specific network topology.

1. What is the scope of your network topology?
If it is a SOHO/SMB network, then logging to the FortiGate unit’s local hard disk or the default FortiCloud service
would be efficient. If the network topology is a large enterprise, you will need FortiAnalyzer units, a FortiCloud
contract, Syslog servers, or any combination.

2. Is archiving required?
If the network activity that is being logged needs to be archived, then, depending on your network topology, you
would choose a FortiAnalyzer unit. FortiAnalyzer units store archives in the same way that FortiGate units do, but
are able to store large amounts of logs and archives.

3. When troubleshooting, you may want to log a larger amount of traffic; how much storage space will
you need?
Logs can be configured to roll, which is similar to zipping a file; this will lower the space requirements needed to
contain them. You can also download logs from the FortiGate unit and save them on a server or on a computer to
view and access later, to prevent them from piling up and being overwritten. If you’re regularly logging large
amounts of traffic, you should consider a FortiAnalyzer or FortiCloud account .
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4. Should I invest in a log device that can grow as my network grows?
All networks grow, so investing in a device that can grow with your network and that can be expanded is a good
investment. For example, if you currently have a SOHO/SMB topology, but see growth already starting, a
FortiAnalyzer unit would be best. A FortiAnalyzer unit provides ample storage space, and you can add two more
FortiAnalyzer units to access additional storage and create a redundancy log backup solution.
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How to create a backup solution for logging

The following helps to explain how to create a log backup solution for a small network topology. This example has
one FortiAnalyzer unit and a subscription to the FortiCloud Service.

Example of an integrated FortiAnalyzer unit and Syslog servers in a network

Syslog_3192.168.18.121

Internal Network

FortiGate

Syslog_1192.168.16.121 Syslog_2192.168.17.121

FortiAnalyzer
172.16120.154

1. Log in to the CLI and modify what features will be logged to the FortiAnalyzer unit as well as the settings to the
default log device, the FortiGate unit’s hard drive.
By default, the FortiGate unit logs to either the system memory or hard drive, whichever is available on the
FortiGate unit. Low-end FortiGate units may have logging disabled by default.

2. In the CLI, use the config log fortianalyzer setting command to configure logging to the
FortiAnalyzer unit.
You can only configure log settings for the FortiAnalyzer unit in the CLI. Configuring to upload logs to a
FortiAnalyzer unit can be configured in both the CLI and web-based manager.

3. In the CLI, configure the settings for the Syslog server; also enable reliable syslog as well.
Reliable syslog verifies that logs are sent to the syslog server. When you enable this setting, the default port
becomes port 601.

Reports
Reports provide a clear, concise overview of what is happening on your network based on log data, and can be
customized to serve different purposes. There are three types of reports supported by the FortiGate: FortiOS
Reports, FortiCloud Reports, and FortiAnalyzer Reports.

FortiOS Reports are generated and configured on the FortiGate unit itself, FortiCloud Reports are created and
configured on the FortiCloud site and mirrored to the connected FortiGate for viewing, and FortiAnalyzer reports
are created and configured on a FortiAnalyzer unit. For more information about those reports, see the
FortiAnalyzer Administration Guide.
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In order to create FortiOS Reports on a device, disk logging must be enabled. Not all devices are capable of disk
logging; check the Feature Matrix to see if your unit has a hard disk. Once disk logging has been enabled, Local
Reports can then be enabled in System > Feature Visibility in order to view and edit reports.

What are FortiOS reports?

FortiOS reports are created from logs stored on the FortiGate unit’s hard drive. These reports, generated by the
FortiGate unit itself, provide a central overview of traffic and security features on the FortiGate. A default FortiOS
report, called the FortiGate Security Feature Daily Activity Report, is available for you to use or modify to your
requirements. The default report compiles security feature activity from various security-related logs, such as
virus and attack logs. You can quickly and easily create your own report from within the management interface.

What you can do with the default FortiOS report

On the Log & Report > Local Reports page, you can set the frequency and timing of auto-generated reports.

You can select Run Nowon the Local Reports page to immediately create a report with the current layout and
design. More complex reports may take longer to generate. After generating a report, you can view it by selecting
it from the list belowRun Now.

Historical reports will be marked as ‘Scheduled’ if created automatically, or ‘On Demand’ if created by selecting
Run Now.

What are FortiCloud reports?

FortiCloud reports are created from logs stored on the FortiCloud log management service. An active FortiCloud
Service Subscription is required in order to view, configure, or use these reports. They are generated by
FortiCloud according to a schedule you set, and then mirrored to the FortiGate interface and can be viewed at
Log & Report > FortiCloud Reports, which may not appear in the interface until a report is created. If you
wish to configure the report design or structure, you will have to do so from the FortiCloud portal website.

See the FortiCloud Administration Guide for more information about using and configuring FortiCloud reports.

Best Practices: Log management
When the FortiGate unit records FortiGate activity, valuable information is collected that provides insight into
how to better protect network traffic against attacks, including misuse and abuse. There is a lot to consider before
enabling logging on a FortiGate unit, such as what FortiGate activities to enable and which log device is best
suited for your network’s logging needs. A plan can help you in deciding the FortiGate activities to log, a log
device, as well as a backup solution in the event the log device fails.

This plan should provide you with an outline, similar to the following:

l what FortiGate activities you want and/or need logged (for example, security features)
l the logging device best suited for your network structure
l if you want or require archiving of log files
l ensuring logs are not lost in the event a failure occurs.

After the plan is implemented, you need to manage the logs and be prepared to expand on your log setup when
the current logging requirements are outgrown. Good log management practices help you with these tasks.

Log management practices help you to improve and manage logging requirements. Logging is an ever-expanding
tool that can seem to be a daunting task to manage. The following management practices will help you when
issues arise, or your logging setup needs to be expanded.
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1. Revisit your plan on a yearly basis to verify that your logging needs are being met by your current log setup. For
example, your company or organization may require archival logging, but not at the beginning of your network’s
lifespan. Archival logs are stored on a FortiGate unit’s local hard drive, a FortiAnalyzer unit, or a FortiCloud server,
in increasing order of size.

2. Configure an alert message that will notify you of activities that are important to be aware about. For example: if a
branch office does not have a FortiGate administrator, you will need to know at all times that the IPsec VPN tunnel
is still up and running. An alert email notification message can be configured to send only if IPsec tunnel errors
occur.

3. If your organization or company uses peer-to-peer programs such as Skype or other instant messaging software,
use the Applications FortiView dashboard, or the Executive Summary’s report widget (Top 10 Application
Bandwidth Usage Per Hour Summary) to help you monitor the usage of these types of instant messaging
software. These widgets can help you in determining how these applications are being used, including if there is
any misuse and abuse. Their information is taken from application log messages; however, application log
messages should be viewed as well since they contain the most detailed information.

4. Ensure that your backup solution is up-to-date. If you have recently expanded your log setup, you should also
review your backup solution. The backup solution provides a way to ensure that all logs are not lost in the event
that the log device fails or issues arise with the log device itself.
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Logging and reporting for small networks

This section explains how to configure the FortiGate unit for logging and reporting in a small office or SOHO/SMB
network. To properly configure this type of network, you will be modifying the default log settings, as well as the
default FortiOS report.

The following procedures are examples and can be used to help you when configuring your own network’s log
topology. Since some of these settings must be modified or enabled or disabled in the CLI, it is recommended to
review the FortiGate CLI Reference for any additional information about the commands used herein, as well as
any that you would need to use in your own network’s log topology.

Modifying default log device settings
The default log device settings must be modified so that system performance is not compromised. The FortiGate
unit, by default, has all logging of FortiGate features enabled, except for traffic logging. The default logging
location will be either the FortiGate unit’s system memory or hard disk, depending on the model. Units with a
flash disk are not recommended for disk logging.

Modifying the FortiGate unit’s system memory default settings

When the FortiGate unit’s default log device is its system memory, the following is modified for a small network
topology. The following is an example of how to modify these default settings.

To modify the default system memory settings

1. Log in to the CLI.
2. Enter the following command syntax to modify the logging settings:

config log memory setting
set status enable

end

3. The following example command syntax modifies which FortiGate features that are enabled for logging:
config log memory filter

set forward-traffic enable
set local-traffic enable
set sniffer-traffic enable
set anomaly enable
set voip disable
set multicast-traffic enable
set dns enable

end

Modifying the FortiGate unit’s hard disk default settings

When the FortiGate unit’s default log device is its hard disk, you need to modify those settings to your network’s
logging needs so that you can effectively log what you want logged. The following is an example of how to modify
these default settings.
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To modify the default hard disk settings

1. Log in to the CLI.
2. Enter the following command syntax to modify the logging settings:

config log disk setting
set ips-archive disable
set status enable
set max-log-file-size 1000
set storage FLASH
set log-quota 100
set report-quota 100

end

3. In the CLI, enter the following to disable certain event log messages that you do not want logged:
config log eventfilter

set event enable
set system enable
set vpn disable
set user enable
set router disable
set wan-opt disable

end

Testing sending logs to the log device

After modifying both the settings and the FortiGate features for logging, you can test that the modified settings
are working properly. This test is done in the CLI.

To test sending logs to the log device

1. In the CLI, enter the following command syntax:
diag log test

When you enter the command, the following appears:

generating a system event message with level - warning
generating an infected virus message with level - warning
generating a blocked virus message with level - warning
generating a URL block message with level - warning
generating a DLP message with level - warning
generating an IPS log message
generating an anomaly log message
generating an application control IM message with level - information
generating an IPv6 application control IM message with level - information
generating deep application control logs with level - information
generating an antispam message with level - notification
generating an allowed traffic message with level - notice
generating a multicast traffic message with level - notice
generating a ipv6 traffic message with level - notice
generating a wanopt traffic log message with level - notification
generating a HA event message with level - warning
generating netscan log messages with level - notice
generating a VOIP event message with level - information
generating a DNS event message with level - information
generating authentication event messages
generating a Forticlient message with level - information

2315 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Logging and reporting for small networks

generating a URL block message with level - warning

2. In the web-based interface, go to Log & Report > System Events, and view the logs to see some of the
recently generated test log messages.
You will be able to tell the test log messages from real log messages because they do not have “real” information;
for example, the test log messages for the vulnerability scan contain the destination IP address of 1.1.1.1 or
2.2.2.2.

Configuring the backup solution
A backup solution provides a way to ensure logs are not lost. The following backup solution explains logging to a
FortiCloud server and uploading logs to a FortiAnalyzer unit. With this backup solution, there can be three
simultaneous storage locations for logs, the first being the FortiGate unit itself, the FortiAnalyzer unit and then
the FortiCloud server.

Configuring logging to a FortiCloud server

The FortiCloud server can be used as a redundant backup, or your primary logging solution. The following
assumes that this service has already been registered, and a subscription has been purchased for expanded
space. The following is an example of how to these settings are configured for a network’s log configuration. You
need to have access to both the CLI and the web-based manager when configuring uploading of logs. The upload
time and interval settings can be configured in the web-based interface.

To configure logging to the FortiCloud server

1. Go to Dashboard and click Login next to FortiCloud in the License Information widget.
2. Enter your username and password, and clickOK. (Or register, if you have not yet done so.)
3. Logs will automatically be uploaded to FortiCloud as long as your FortiGate is linked to your FortiCloud account.
4. To configure the upload time and interval, go to Log & Report > Log Settings.
5. Under the Logging and Archiving header, you can select your desired upload time.
With FortiCloud you can easily store and access FortiGate logs that can give you valuable insight into the health
and security of your network.

Configuring uploading logs to the FortiAnalyzer unit

The logs will be uploaded to the FortiAnalyzer unit at a scheduled time. The following is an example of how to
upload logs to a FortiAnalyzer unit.

To upload logs to a FortiAnalyzer unit

1. Go to Log & Report > Log Settings.
2. In the Remote Logging and Archiving section, select the check box beside Send Logs to

FortiAnalyzer/FortiManager.
3. Select FortiAnalyzer (Daily at 00:00).
4. Enter the FortiAnalyzer unit’s IP address in the IP Address field.
5. To configure the daily upload time, open the CLI.
6. Enter the following to configure when the upload occurs, and the time when the unit uploads the logs:

config log fortianalyzer setting
set upload-interval {daily | weekly | monthly}
set upload-time <hh:mm>
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end

7. To change the upload time, in the web-based manager, select Change beside the upload time period, and then
make the changes in the Upload Schedule window. Select OK.

Testing uploading logs to a FortiAnalyzer unit

You should test that the FortiGate unit can upload logs to the FortiAnalyzer unit, so that the settings are
configured properly.

To test the FortiAnalyzer upload settings

1. Go to Log & Report > Log Settings.
2. In the Logging and Archiving section, under Send Logs to FortiAnalyzer/FortiManager, change the time to

the current time by selecting Change.
For example, the current time is 11:10 am, so Change now has the time 11:10.

3. Select OK.
The logs will be immediately sent to the FortiAnalyzer unit, and will be available to view from within the
FortiAnalyzer’s interface.
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Logging and reporting for large networks

This section explains how to configure the FortiGate unit for logging and reporting in a larger network, such as an
enterprise network. To set up this type of network, you are modifying the default log settings, and you are also
modifying the default report.

The following procedures are examples and can be used to help you when configuring your own network’s log
topology.

Since some of these settings must be modified or enabled or disabled in the CLI, it is recommended to review the
FortiGate CLI Reference for any additional information about the commands used herein, as well as any that you
would need to use in your own newtork’s log topology.

Modifying default log device settings
The default log device settings must be modified so that system performance is not compromised. The FortiGate
unit, by default, has all logging of FortiGate features enabled and well as logging to either the FortiGate unit’s
system memory or hard disk, depending on the model.

Modifying multiple FortiGate units’ system memory default settings

When the FortiGate unit’s default log device is its system memory, you can modify it to fit your log network
topology. In this topic, the following is an example of how you can modify these default settings.

To modify the default system memory settings

1. Log in to the CLI.
2. Enter the following command syntax to modify the logging settings:

config log memory setting
set status enable

end

3. Enter the following command syntax to modify the FortiGate features that are enabled for logging:
config log memory filter

set forward-traffic enable
set local-traffic enable
set sniffer-traffic enable
set anomaly enable
set voip enable
set multicast-traffic enable
set dns enable

end

4. Repeat steps 2 and 3 for the other FortiGate units.
5. Test the modified settings using the procedure below.

Modifying multiple FortiGate units’ hard disk default log settings

You will have to modify each FortiGate unit’s hard disk default log settings. The following is an example of how to
modify these default settings.
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To modify the default hard disk settings

1. Log in to the CLI.
2. Enter the following command syntax to modify the logging settings:

config log disk setting
set ips-archive disable
set status enable
set max-log-file-size 1000
set storage Internal
set log-quota 100
set report-quota 100

end

3. In the CLI, enter the following to disable certain event log messages that you do not want logged:
config log eventfilter

set event enable
set system enable
set vpn enable
set user enable
set router disable
set wan-opt disable

end

4. Repeat the steps 2 to 4 for the other FortiGate units.
5. Test the modified settings using the procedure below.

Testing the modified log settings

After modifying both the settings and the FortiGate features for logging, you can test that the modified settings
are working properly. This test is done in the CLI.

To test sending logs to the log device

1. In the CLI, enter the following command syntax:
diag log test

When you enter the command, the following appears:

generating a system event message with level - warning
generating an infected virus message with level - warning
generating a blocked virus message with level - warning
generating a URL block message with level - warning
generating a DLP message with level - warning
generating an IPS log message
generating an anomaly log message
generating an application control IM message with level - information
generating an IPv6 application control IM message with level - information
generating deep application control logs with level - information
generating an antispam message with level - notification
generating an allowed traffic message with level - notice
generating a multicast traffic message with level - notice
generating a ipv6 traffic message with level - notice
generating a wanopt traffic log message with level - notification
generating a HA event message with level - warning
generating netscan log messages with level - notice
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generating a VOIP event message with level - information
generating a DNS event message with level - information
generating authentication event messages
generating a Forticlient message with level - information
generating a URL block message with level - warning

2. In the web-based interface, go to Log & Report > System Events, and view the logs to see some of the
recently generated test log messages.
You will be able to tell the test log messages from real log messages because they do not have “real” information;
for example, the test log messages for the vulnerability scan contain the destination IP address of 1.1.1.1 or
2.2.2.2.

Configuring the backup solution
Even though you are logging to multiple FortiAnalyzer units, this is more of a redundancy solution rather than a
complete backup solution in this example.

The multiple FortiAnalyzer units act similar to a HA cluster, since if one FortiAnalyzer unit fails, the others
continue storing the logs they receive. In a backup solution, the logs are backed up to another secure location if
something happens to the log device.

A good alternate or redundant option is the FortiCloud service, which can provide secure online logging and
management for multiple devices.

Configuring logging to multiple FortiAnalyzer units

The following example shows how to configure logging to multiple FortiAnalyzer units. Configuring multiple
FortiAnalyzer units is quick and easy; however, you can only configure up to three FortiAnalyzer units per
FortiGate unit.

To configure multiple FortiAnalyzer units

1. In the CLI, enter the following command syntax to configure the first FortiAnalyzer unit:
config log fortianalyzer setting

set status enable
set server 172.20.120.22
set max-buffer-size 1000
set buffer-max-send 2000
set address-mode static
set conn-timeout 100
set monitor-keepalive-period 120
set monitor-failure-retry-period 2000

end

2. Disable the features that you do not want logged, using the following example command syntax. You can view the
CLI Reference to see what commands are available.

config log fortianalyzer filter
set forward-traffic (enable | disable)
...

end

3. Enter the following commands for the second FortiAnalyzer unit:
config log fortianalyzer2 setting

set status enable
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set server 172.20.120.23
set max-buffer-size 1000
set buffer-max-send 2000
set address-mode static
set conn-timeout 100
set monitor-keepalive-period 120
set monitor-failure-retry-period 2000

end

4. Disable the features that you do not want logged, using the following example command syntax.
config log fortianalyzer2 filter

set event (enable | disable)
...

end

5. Enter the following commands for the last FortiAnalyzer unit:
config log fortianalyzer3 setting

set status enable
set server 172.20.120.23
set max-buffer-size 1000
set buffer-max-send 2000
set address-mode static
set conn-timeout 100
set monitor-keepalive-period 120
set monitor-failure-retry-period 2000

end

6. Disable the features that you do not want logged, using the following example command syntax.
config log fortianalyzer3 filter

set voip (enable | disable)
...

end

7. Test the configuration by using the procedure, “Testing the modified log settings”.
8. On the other FortiGate units, configure steps 1 through 6, ensuring that logs are being sent to the FortiAnalyzer

units.

Configuring logging to the FortiCloud server

The FortiCloud server can be used as a redundant backup, or your primary logging solution. The following
assumes that this service has already been registered, and a subscription has been purchased for expanded
space. The following is an example of how to these settings are configured for a network’s log configuration. You
need to have access to both the CLI and the web-based manager when configuring uploading of logs. The upload
time and interval settings can be configured in the web-based interface.

To configure logging to the FortiCloud server

1. Go to Dashboard and click Login next to FortiCloud in the License Information widget.
2. Enter your username and password, and clickOK. (Or register, if you have not yet done so.)
3. Logs will automatically be uploaded to FortiCloud as long as your FortiGate is linked to your FortiCloud account.
4. To configure the upload time and interval, go to Log & Report > Log Settings.
5. Under the Remote Logging and Archiving header, you can select your desired upload time.
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6. With FortiCloud you can easily store and access FortiGate logs that can give you valuable insight into the health
and security of your network.
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Advanced logging

This section explains how to configure other log features within your existing log configuration. You may want to
include other log features after initially configuring the log topology because the network has either outgrown the
initial configuration, or you want to add additional features that will help your network’s logging requirements.

The following topics are included in this section:

l Log backup and restore tools
l Configuring logging to multiple Syslog servers
l Using Automatic Discovery to connect to a FortiAnalyzer unit
l Activating a FortiCloud account for logging purposes
l Viewing log storage space
l Customizing and filtering log messages
l Viewing logs from the CLI
l Configuring NAC quarantine logging
l Logging local-in policies
l Tracking specific search phrases in reports
l Advanced logging

Log backup and restore tools
Local disk logs can now be backed up and restored to local files, using CLI commands:

execute log backup <filename>
execute log restore <filename>

Restoring logs will wipe the current log and report content off the disk.

Logs can also now be exported to a USB storage device, as LZ4 compressed files, from both CLI and GUI. When
you insert a USB drive into the FortiGate's USB port, the USBmenu will appear in the GUI. The menu shows the
amount of storage on the USB disk, and the log file size, and you can select Copy to USB to copy the log data to
the drive.

Configuring logging to multiple Syslog servers
A single remote Syslog server can be configured in the GUI, in Log & Report > Log Settings, but for a larger
network, you will have to configure it in the CLI.

When configuring multiple Syslog servers (or one Syslog server), you can configure reliable delivery of log
messages from the Syslog server. Configuring of reliable delivery is available only in the CLI.

If VDOMs are enabled, you can configure separate FortiAnalyzer unit or Syslog server for each VDOM.

To enable logging to multiple Syslog servers:

1. Log in to the CLI.
2. Enter the following commands:

config log syslogd setting
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set csv {disable | enable}
set facility <facility_name>
set port <port_integer>
set reliable {disable | enable}
set server <ip_address>
set status {disable | enable}

end

3. Enter the following commands to configure the second Syslog server:
config log syslogd2 setting

set csv {disable | enable}
set facility <facility_name>
set port <port_integer>
set reliable {disable | enable}
set server <ip_address>
set status {disable | enable}

end

4. Enter the following commands to configure the third Syslog server:
config log syslogd3 setting

set csv {disable | enable}
set facility <facility_name>
set port <port_integer>
set reliable {disable | enable}
set server <ip_address>
set status {disable | enable}

end

5. Enter the following commands to configure the fourth Syslog server:
config log syslogd4 setting

set csv {disable | enable}
set facility <facility_name>
set port <port_integer>
set reliable {disable | enable}
set server <ip_address>
set status {disable | enable}

end

Most FortiGate features are, by default, enabled for logging. You can disable individual FortiGate features you do
not want the Syslog server to record, as in this example:

config log syslogd filter
set local-traffic {enable | disable}
set severity {alert | critical | debug | emergency | error | information |

notification | warning}
end

Using Automatic Discovery to connect to a FortiAnalyzer unit
Automatic Discovery can be used if the FortiAnalyzer unit is on the same network.

To connect using automatic discovery

1. Log in to the CLI.
2. Enter the following command syntax:

config log fortianalyzer setting
set status enable
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set server <ip_address>
set gui-display enable
set address-mode auto-discovery

end

If your FortiGate unit is in Transparent mode, the interface using the automatic discovery feature will not carry
traffic. For more information about how to enable the interface to also carry traffic when using the automatic
discovery feature, see the Fortinet Knowledge Base article, Fortinet Discovery Protocol in Transparent mode.

The FortiGate unit searches within the same subnet for a response from any available
FortiAnalyzer units.

Activating a FortiCloud account for logging purposes
When you subscribe to FortiCloud, you can configure to send logs to the FortiCloud server. The account
activation can be done within the web-based manager, from the License Information widget located in
Dashboard.

From this widget, you can easily create a new account, or log in to the existing account. From within the License
Information widget, after the account is activated, you can go directly to the FortiCloud web portal, or log out of
the service if you are already logged in.

To activate a FortiCloud account for logging purposes:

The following assumes that you are already at Dashboard and that you have located the License Information
widget.

1. In the License Information widget, select Activate in the FortiCloud section.
The Registration window appears. From this window, you create the login credentials that you will use to access
the account.

2. Select Create Account and enter then information for the login credentials.
After entering the login credentials, you are automatically logged in to your FortiCloud account.

3. Check that the account has been activated by viewing the account status from the License Information widget.
If you need more space, you can subscribe to the 200Gb FortiCloud service by selecting Upgrade in the
FortiCloud section of the widget.

Viewing log storage space
The Log & Report > Log SettingsGUI page displays two charts to visualize disk space: Disk Usage, which is a
pie-chart illustrating the Free/Used space on the internal hard drive, and Historical Disk Usage, which displays the
volume of disk logging activity over time. These charts may not be visible if disk logging is disabled.

The diag sys logdisk usage command allows you to view detailed information about how much space is
currently being used for logs. This is useful when you see a high percentage, such as 92 percent for the disk’s
capacity. The FortiGate unit uses only 75 percent of the available disk capacity to avoid a high storage amount so
when there is a high percentage, it refers to the percentage of the 75 percent that is available. For example, 92
percent of the 75 percent is available.

The following is an example of what you may see when you use diag sys logdisk usage command on a
unit with no VDOMs configured:

diag sys logdisk usage
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The following appears:

Total HD usage: 176MB/3011 MB
Total HD logging space: 22583MB
Total HD logging space for each vdom: 22583MB
HD logging space usage for vdom "root": 30MB/22583MB

Customizing and filtering log messages
When viewing log messages, you may want to customize and filter the information that you are seeing in the Log
& Report menu (for example, Log & Report > Traffic Log > Forward Traffic). Filtering and customizing the display
provides a way to view specific log information without scrolling through pages of log messages to find the
information.

Customizing log messages is the process of removing or adding columns to the log display page, allowing you to
view certain desired information. The most columns represent the fields from within a log message, for example,
the user column represents the user field, as well as additional information. If you want to reset the customized
columns on the page back to their defaults, you need to select Reset All Columnswithin the column title right-
click menu.

Filtering information is similar to customizing, however, filtering allows you to enter specific information that
indicates what should appear on the page. For example, including only log messages that appeared on February
24, between the hours of 8:00 and 8:30 am.

To customize and filter log messages

The following is an example that displays all traffic log messages that originate from the source IP address
172.20.120.24, as well as displaying only the columns:

l OSName
l OSVersion
l Policy ID
l Src (Source IP)

The following assumes that you are already on the page of the log messages you want to customize and filter. In
this example, the log messages that we are customizing and filtering are in Log & Report > Forward Traffic.

1. On the Forward Traffic page, right click anywhere on a column title.
2. Right click on a column title, and mouse overColumn Settings to open the list.
3. Select each checkmarked title to uncheck it and remove them all from the displayed columns.
4. Scroll down to the list of unchecked fields and select ‘OS Name’, ‘OS Version’, ‘Policy ID’, and ‘Src’ to add

checkmarks next to them.
5. Click outside the menu, and wait for the page to refresh with the new settings in place.
6. Select the funnel icon next to the word Src in the title bar of the Src column.
7. Enter the IP you want displayed (in this example, 172.20.120.24) in the text box.
8. ClickApply, and wait for the page to reload.

Viewing logs from the CLI
You can easily view log messages from within the CLI. In this example, we are viewing DLP log messages.

1. Log in to the CLI and then enter the following to configure the display of the DLP log messages.
execute log filter category 9
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execute log filter start-line 1
execute log filter view-lines 20

The customized display of log messages in the CLI is similar to how you customize the display of log
messages in the web-based manager. For example, category 9 is the DLP log messages, and the
start-line is the first line in the log database table for DLP log messages, and there will be 20
lines (view-lines 20) that will display.

2. Enter the following to view the log messages:
execute log display

The following appears below execute log display:

600 logs found
20 logs returned

along with the 20 DLP log messages.

Configuring NAC quarantine logging
NAC quarantine log messages provide information about what was banned and quarantined by a Antivirus profile.
The following explains how to configure NAC quarantine logging and enable it on a policy. This procedure
assumes the Antivirus profile is already in place.

To configure NAC quarantine logging

1. Go to Policy & Objects > IPv4 Policy.
2. Select the policy that you want to apply the Antivirus profile to, and then select Edit.
3. Within the Security Profiles section, enable Antivirus and then select the profile from the drop-down list.
4. Select OK.
5. Log in to the CLI.
6. Enter the following to enable NAC quarantine in the DLP sensor:

config antivirus profile
edit <profile_name>

config nac-quar log enable
end

Logging local-in policies
Local-in security policies are policies the control the flow of internal traffic, and can be used to broaden or restrict
an administrator’s access privileges. These local-in policies can also be configured to log traffic and activity that
the policies control.

You can enable logging of local-in policies in the CLI, with the following commands:

config system global
set gui-local-in-policy enable

end

The Local-In Policy page will then be available in Policy & Objects > Local In Policy. You can configure what
local-in traffic to log in the CLI, or in Log & Report > Log Settings, under Local Traffic Logging.

When deciding what local-in policy traffic you want logged, consider the following:
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Special Traffic

Traffic activity Traffic Direction Description

FortiGuard
update
annoucements

IN All push announcements of updates that are coming from the
FortiGuard system. For example, IPS or AV updates.

FortiGuard
update requests OUT All updates that are checking for antivirus or IPS as well as other

FortiGuard service updates.

Firewall
authentication

IN The authentication made using either the web-based manager
or CLI.

Central
management (a
FortiGate unit
being managed
by a
FortiManager
unit)

IN The access that a FortiManager has managing the FortiGate
unit.

DNS IN All DNS traffic.

DHCP/DHCP
Relay IN All DHCP and/or DHCPRelay traffic.

HA (heart beat
sync policy)

IN/OUT For high-end platforms with a backplane heart beat port.

HA (Session sync
policy) IN/OUT This will get information from the CMDB and updated by session

sync daemon.

CAPWAP IN This activity is logged only when a HAVE_CAPWAP is defined.

Radius IN This is recorded only within FortiCarrier.

NETBIOS forward IN Any interface that NETBIOS forward is enabled on.

RIP IN

OSPF IN

VRRP IN

BFD IN

IGMP IN This is recorded only when PIM is enabled.

PIM IN This is recorded only when PIM is enabled.
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Traffic activity Traffic Direction Description

BGP IN This is recorded only when config bgp and bgp neightbor is
enabled in the CLI.

WCCP policy IN Any interface that WCCP is enabled; however, if in Cache
mode, this is not recorded because it is not available.

WAN Opt/ Web
Cache IN Any interface where WAN Opt is enabled.

WANOpt Tunnel IN This is recorded when HAVE_WANOPT is defined.

SSL-VPN IN Any interface from a zone where the action in the policy is SSL
VPN.

IPSEC IN

L2TP IN

PPTP IN

VPD IN This is recorded only when FortiClient is enabled.

Web cache db
test facility

IN This is recorded only when WA_CS_REMOTE_TEST is defined.

GDBserver IN This is recorded only when debug is enabled.

Tracking specific search phrases in reports
It is possible to use the Web Filter to track specific search keywords and phrases and record the results for display
in the report.

You should verify that the web filter profile you are using indicates what search phrases you want to track and
monitor, so that the report includes this information.

1. Log in to the CLI and enter show webfilter profile default.
This provides details about the webfilter profile being used by the security policy. In this example, the details
(shown in the following in bold) indicate that safe search is enabled, but not specified or being logged.

show webfilter profile default
config webfilter profile

edit "default"
set comment "default web filtering"
set inspection-mode flow-based
set options https-scan
set post-action comfort

config web
set safe-search url

end
config ftgd-wf

config filters
edit 1
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set action block
set category 2

next
edit 2

set action block
set category 7

next
edit 3

set action block
set category 8

2. Enter the following command syntax so that logging and the keyword for the safe search will be
included in logging.

config webfilter profile
edit default

config web
set log-search enable
set keyword-match "fortinet" "easter" "easter bunny"

end
end

3. To test that the keyword search is working, go to a web browser and begin searching for the words
that were included in the webfilter profile, such as easter.
You can tell that the test works by going to Log & Report > Forward Traffic and viewing the log messages.
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Troubleshooting and logging

This section explains how to troubleshoot logging configuration issues, as well as connection issues, that you
may have with your FortiGate unit and a log device. This section also contains information about how to use log
messages when troubleshooting issues that are about other FortiGate features, such as VPN tunnel errors.

Using log messages to help in troubleshooting issues
Log messages can help when troubleshooting issues that occur, since they can provide details about what is
occurring. The uses and methods for involving logging in troubleshooting vary depending on the problem. The
following are examples of how log messages can assist when troubleshooting networking issues.

Using IPS packet logging in diagnostics

This type of logging should only be enabled when you need to know about specific diagnostic information, for
example, when you suspect a signature is triggered by a false positive. These log messages can help
troubleshoot individual problems with misidentified or missing packets and network intrusions involving malicious
packets.

To configure IPS packet logging

1. Go to Security Profiles > Intrusion Protection.
2. Select the IPS sensor that you want to enable IPS packet logging on, and then select Edit.
3. In the filter options, enable Packet Logging.
4. Select OK.
If you want to configure the packet quota, number of packets that are recorded before alerts and after attacks,
use the following procedure.

To configure additional settings for IPS packet logging

1. Log in to the CLI.
2. Enter the following to start configuring additional settings:

config ips settings
set ips-packet-quota <integer>
set packet-log-history <integer>
set packet-log-post-attack <integer>

end

Using HA log messages to determine system status

When the FortiGate unit is in HAmode, you may see the following log message content within the event log:

type=event subtype=ha level=critical msg= “HA slave heartbeat interface internal lost
neighbor information”

OR

type=event subtype=ha level=critical msg= “Virtual cluster 1 of group 0 detected new
joined HA member”

OR
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type=event subtype=ha level=critical msg= “HA master heartbeat interface internal get peer
information”

The log messages occur within a given time, and indicate that the units within the cluster are not aware of each
other anymore. These log messages provide the information you need to fix the problem.

Connection issues between FortiGate unit and logging devices
If external logging devices are not recording the log information properly or at all, the problem will likely be due to
one of two situations: no data is being received because the log device cannot be reached, or no data is being
sent because the FortiGate unit is no longer logging properly.

Unable to connect to a supported log device

After configuring logging to a supported log device, and testing the connection, you may find you cannot connect.
To determine whether this is the problem:

1. Verify that the information you entered is correct; it could be a simple mistake within the IP address or you may
have not selected Apply on the Log Settings page after changing them, which would prevent them from taking
effect.

2. Use execute ping to see if you can ping to the log device.
3. If you are unable to ping to the log device, check to see if the log device itself working and that it is on the network

and assigned an appropriate address.

FortiGate unit has stopped logging

If the FortiGate unit stopped logging to a device, test the connection between both the FortiGate unit and device
using the execute ping command. The log device may have been turned off, is upgrading to a new firmware
version, or just not working properly.

The FortiGate unit may also have a corrupted log database. When you log into the web-based manager and you
see an SQL database error message, it is because the SQL database has become corrupted. View "SQL
database errors” in the next section before taking any further actions, to avoid losing your current logs.

Log database issues
If attempting to troubleshoot issues with the SQL log database, use the following to help guide you to solving
issues that occur.

SQL statement syntax errors

There may be errors or inconsistencies in the SQL used to maintain the database. Here are some example error
messages and possible causes:

You have an error in your SQL syntax (remote/MySQL)

or

ERROR: syntax error at or near... (local/PostgreSQL)

l Verify that the SQL keywords are spelled correctly, and that the query is well-formed.
l Table and column names are demarked by grave accent (`) characters. Single (') and double (") quotation marks will

cause an error.

No data is covered.
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l The query is correctly formed, but no data has been logged for the log type. Verify that you have configured the
FortiGate unit to save that log type. On the Log Settings page, make sure that the log type is checked.

Connection problems

If well-formed SQL queries do not produce results, and logging is turned on for the log type, there may be a
database configuration problem with the remote database.

Ensure that:

l MySQL is running and using the default port 3306.
l You have created an empty database and a user who has read/write permissions for the database.
l Here is an example of creating a new MySQL database named fazlogs, and adding a user for the database:

1. #Mysql –u root –p

2. mysql> Create database fazlogs;
3. mysql> Grant all privileges on fazlogs.* to ‘fazlogger’@’*’ identified by ‘fazpassword’;
4. mysql> Grant all privileges on fazlogs.* to ‘fazlogger’@’localhost’ identified by ‘fazpassword’;

SQL database errors

If the database seems inacessible, you may encounter the following error message after upgrading or
downgrading the FortiGate unit’s firmware image.

Example of an SQL database error message

The error message indicates that the SQL database is corrupted and cannot be updated with the SQL schemas
any more. When you see this error message, you can do one of the following:

l select Cancel and back up all log files; then select Rebuild to blank and rebuild the database.
l select Rebuild immediately, which will blank the database and previous logs will be lost.
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Until the database is rebuilt, no information will be logged by the FortiGate unit regardless of the log settings that
are configured on the unit. When you select Rebuild, all logs are lost because the SQL database is erased and
then rebuilt again. Logging resumes automatically according to your settings after the SQL database is rebuilt.

To view the status of the database, use the diagnose debug sqldb-error status command in the CLI.
This command will inform you whether the database has errors present.

If you want to view the database’s errors, use the diagnose debug sqldb-error read command in the
CLI. This command indicates exactly what errors occurred, and what tables contain those errors.

Log files are backed up using the execute backup {disk | memory } {alllogs | logs} command
in the CLI. You must use the text variable when backing up log files because the text variable allows you to view
the log files outside the FortiGate unit. When you back up log files, you are really just copying the log files from
the database to a specified location, such as a TFTP server.

Logging daemon (Miglogd)
The number of logging daemon child processes has been made available for editing. A higher number can affect
performance, and a lower number can affect log processing time, although no logs will be dropped or lost if the
number is decreased.

If you are suffering from performance issues, you can alter the number of logging daemon child processes, from 0
to 15, using the following syntax. The default is 8.

config system global
set miglogd-children <integer>

end

There is currently no supported method for monitoring and triggering alert messages
based on current logging status, logging activity, or miglogd status.
Alert emails can be sent based on log disk capacity status.
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Chapter 19 - Managing Devices

Managing devices

Welcome and thank you for selecting Fortinet products for your network protection.

This chapter contains the following topics:

Before you begin
Before you begin using this guide, please ensure that:

l You have administrative access to the web-based manager and/or CLI.
l The FortiGate unit is integrated into your network.
l The operation mode has been configured.
l The system time, DNS settings, administrator password, and network interfaces have been configured.
l Firmware, FortiGuard Antivirus and FortiGuard Antispam updates are completed.
l Any third-party software or servers have been configured using their documentation.

While using the instructions in this guide, note that administrators are assumed to be super_admin administrators
unless otherwise specified. Some restrictions will apply to other administrators.

How this guide is organized
This handbook chapter contains the following sections:

Managing “bring your own device” describes device monitoring, devices, device groups, and device policies. The
administrator can monitor all types of devices and control their access to network resources.

What's New in FortiOS 5.6

This chapter describes new Device identification features added to FortiOS 5.6.

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

Changed default for device-identification-active-scan to disabled (380837)

It was decided that most customers would not appreciate a default setting that resulted in the FortiGate probing
their systems, so active scan option is changed to disabled by default going forward, but upgrade code is added
to keep the option enabled for those upgrading from 5.4.0 or 5.4.1 who were using device-identification with
active scan enabled.
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Managing “bring your own device”

FortiOS can control network access for different types of personal mobile devices that your employees bring onto
your premises. You can:

l identify and monitor the types of devices connecting to your networks, wireless or wired
l use MAC address based access control to allow or deny individual devices
l create security policies that specify device types
l enforce endpoint control on devices that can run FortiClient Endpoint Control software

This chapter contains the following sections:

Device monitoring
The FortiGate unit can monitor your networks and gather information about the devices operating on those
networks. Collected information includes:

l MAC address
l IP address
l operating system
l hostname
l user name
l how long ago the device was detected and on which FortiGate interface

You can go to User & Device > Device Inventory to view this information. Mouse-over the Device column for
more details.

Depending on the information available, the Device column lists the Alias or the MAC address of the device. For
ease in identifying devices, Fortinet recommends that you assign each device an Alias.

Device monitoring is enabled separately on each interface. Device detection is intended for devices directly
connected to your LAN ports. If enabled on a WAN port, device detection may be unable to determine the
operating system on some devices. Hosts whose device type cannot be determined passively can be found by
enabling active scanning on the interface.

You can also manually add devices. This enables you to ensure that a device with multiple interfaces is displayed
as a single device.
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To configure device monitoring

1. Go to Network > Interfaces.
2. Edit the interface that you want to monitor devices on.
3. In Networked Devices, turn on Device Detection and optionally turn on Active Scanning.
4. Select OK.
5. Repeat steps 2 through 4 for each interface that will monitor devices.

To assign an alias to a detected device or change device information

1. Go to User & Device > Device Inventory and edit the device entry.
2. Enter an Alias such as the user’s name to identify the device.
3. Change other information as needed.
4. Select OK.

To add a device manually

1. Go to User & Device > Custom Devices & Groups.
2. Select Create New > Device.
3. Enter the following information:

l Alias (required)
l MAC address
l Additional MACs (other interfaces of this device)
l Device Type
l Optionally, add the device to Custom Groups.
l Optionally, enterComments.

3. Select OK.

Custom avatars for custom devices

You can upload an avatar for a custom device. The avatar is then displayed in the GUI wherever the device is
listed, such as FortiView, log viewer, or policy configuration. To upload an avatar image,clickUpload Image on
the New Device or Edit Device page of User & Device > Custom Devices & Groups. The image can be in
any format your browser supports and will be automatically sized to 36 x 36 pixels for use in the FortiGate GUI.

Device offline timeout

A device is considered offline if it has not sent any packets during the timeout period. The timeout can be set to
any value from 30 to 31 536 000 seconds (365 days). The default value is 300 seconds (5 minutes). The timer is
configurable in the CLI:

config system global
set device-idle-timeout 300

end

Device Groups
You can specify multiple device types in a security policy. As an alternative, you can add multiple device types to
a custom device group and include the group in the policy. This enables you to create a different policy for devices
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that you know than for devices in general.

To create a custom device group and add devices to it

1. Go to User & Device > Custom Devices & Groups.
The list of device groups is displayed.

2. Select Create New > Device Group.
3. Enter a Name for the new device group.
4. Click in theMembers field and click a device type to add. Repeat to add other devices.
5. Select OK.

Controlling access with a MAC Address Access Control List
AMAC Address Access Control List (ACL) allows or blocks access on a network interface that includes a DHCP
server. If the interface does not use DHCP, or if you want to limit network access to a larger group such as
employee devices, it is better to create a device group and specify that group in your security policies.

AMAC Address ACL functions as either

l a list of devices to block, allowing all other devices

or

l a list of devices to allow, blocking all other devices

Allowed devices are assigned an IP address. The Assign IP action assigns the device an IP address from the
DHCP range. In a list of allowed devices, you can also use the Reserve IP action to always provide a specific IP
address to the device.

The Unknown MAC Address entry applies to "other" unknown, unlisted devices. Its action must be opposite to
that of the other entries. In an allow list, it must block. In a block list, it must allow.

To create a MAC Address ACL to allow only specific devices

1. Go to the SSID or network interface configuration.
2. In the DHCP Server section, expand Advanced.

DHCP Servermust be enabled.
3. InMAC Reservation + Access Control, select Create New and enter an allowed device’sMAC Address.
4. In the IP or Action column, select one of:

l Assign IP— device is assigned an IP address from the DHCP server address range.
l Reserve IP— device is assigned the IP address that you specify.

5. Repeat Steps "Controlling access with a MAC Address Access Control List" on page 2338 and "Controlling access
with a MAC Address Access Control List" on page 2338 for each additional MAC address entry.

6. Set the Unknown MAC Address entry IP or Action to Block.
Devices not in the list will be blocked.

7. Select OK.

To create a MAC Address ACL to block specific devices

1. Go to the SSID or network interface configuration.
2. In the DHCP Server section, expand Advanced.

DHCP Server must be enabled.
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3. InMAC Reservation + Access Control, select Create New and enter theMAC Address of a device that
must be blocked.

4. In the IP or Action column, select Block.
5. Repeat Steps "Controlling access with a MAC Address Access Control List" on page 2338 and "Controlling access

with a MAC Address Access Control List" on page 2338 for each device that must be blocked.
6. Set the Unknown MAC Address entry IP or Action to Assign IP.

Devices not in the list will be assigned IP addresses.
7. Select OK.

MAC Authentication Bypass (MAB)

MAC Authentication Bypass allows devices without 802.1X capability (printers and IP phones for example) to
bypass authentication and be allowed network access based on their MAC address. This feature requires
RADIUS-based 802.1X authentication in which the RADIUS server contains a database of authorized MAC
addresses.

MAC Authentication Bypass is configurable only in the CLI and only on interfaces configured for 802.1X
authentication. For example:

config system interface
edit "lan"

set ip 10.0.0.200 255.255.255.0
set vlanforward enable
set security-mode 802.1X
set security-mac-auth-bypass enable
set security-groups "Radius-group"

end
end

MAC Authentication Bypass is also available on WiFi SSIDs, regardless of authentication type. It is configurable
only in the CLI. You need to enable the radius-mac-auth feature and specify the RADIUS server that will be
used. For example:

config wireless-controller vap
edit "office-ssid"

set security wpa2-only-enterprise
set auth usergroup
set usergroup "staff"
set radius-mac-auth enable
set radius-mac-auth-server "ourRadius"

end
end

Security policies for devices
Security policies enable you to implement policies according to device type. For example:

l Gaming consoles cannot connect to the company network or the Internet.
l Personal tablet and phone devices can connect to the Internet but not to company servers.
l Company-issued laptop computers can connect to the Internet and company servers. Web filtering and antivirus are

applied.
l Employee laptop computers can connect to the Internet, but web filtering is applied. They can also connect to

company networks, but only if FortiClient Endpoint Security is installed to protect against viruses.
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The following images show these policies implemented for WiFi to the company network and to the Internet.

Device policies for company laptop access to the company network
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Device policies for WiFi access to the Internet

The next section explains device policy creation in detail.

Creating device policies

Device-based security policies are similar to policies based on user identity:

l The policy enables traffic to flow from one network interface to another.
l NAT can be enabled.
l UTM protection can be applied.

To create a device policy

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Choose Incoming Interface, Outgoing Interface and Source as you would for any security policy.
3. In Source, select an address and the device types that can use this policy.

You can select multiple devices or device groups.
4. Turn on NAT if appropriate.
5. Configure Security Profiles as you would for any security policy.
6. Select OK.
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Adding endpoint protection

Optionally, you can require that users’ devices connecting to a particular network interface have FortiClient
Endpoint Security software installed. Devices without an up-to-date installation of FortiClient software are
restricted to a captive portal from which the user can download a FortiClient installer. For information about
creating FortiClient profiles, see "Endpoint Protection".

To add endpoint protection to a security policy

1. Go to Network > Interfaces and edit the interface.
2. In Admission Control turn on Allow FortiClient Connections and FortiClient Enforcement.
3. Optionally, select sources (addresses and device types) to exempt from FortiClient enforcement.
4. Optionally, select destination addresses and services to exempt from FortiClient enforcement.
5. Select OK.
FortiOS pushes a FortiClient profile out to the FortiClient software, configuring network protection such as
antivirus, application control, and web category filtering. To create these profiles, go to Security Profiles >
FortiClient Profiles.

FortiClient Endpoint licence updates

FortiClient endpoint licenses for FortiOS 5.6.0 can be purchased in multiples of 100. There is a maximum client
limit based on the FortiGate's model. FortiCare enforces the maximum limits when the customer is applying the
license to a model.

If you are using the ten free licenses for FortiClient, support is provided on the Fortinet Forum
(forum.fortinet.com). Phone support is only available for paid licenses.

Model(s) Maximum client limit

VM00 200

FGT/FWF 30 to 90 series 200

FGT 100 to 400 series 600

FGT 500 to 900 series, VM01, VM02 2,000

FGT 1000 to 2900 series 20,000

FGT 3000 to 3600 series, VM04 50,000

FGT 3700D and above, VM08 and above 100,000

Older FortiClient SKUs will still be valid and can be applied to FortiOS 5.4 and 5.6.
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Managing a FortiSwitch with a FortiGate

NOTE: FortiLink is not supported in Transparent mode.

The maximum number of supported FortiSwitches depends on the FortiGate model:

FortiGate Model Range Number of FortiSwitches Supported

Up to FortiGate-98 and FortiGate-VM01 8

FortiGate-100 to 280 and FortiGate-VM02 24

FortiGate-300 to 5xx 48

FortiGate-600 to 900 and FortiGate-VM04 64

FortiGate-1000 and up 128

FortiGate-3xxx and up, and FortiGate-VM08 and up 256

Supported models
The following table shows the FortiSwitch models that support FortiLink mode when paired with the
corresponding FortiGate models and the listed minimum software releases.

FortiGate and FortiWiFi Models Earliest
FortiOS FortiSwitch Models

FGT-90D 5.2.2 FS-224D-POE

FGT-60D
FGT-100D, 140D, 140D-POE, 140D-T1
FGT-200D, 240D, 280D, 280D-POE

FGT-600C
FGT-800C

FGT-1000C, 1200D, 1500D
FGT-3700D, FGT-3700DX

5.2.3

FSR-112D-POE
FS-108D-POE
FS-124D (POE)

FS-224D-POE and FPOE

5.4.0

All FortiSwitch D-series models.

FortiSwitchOS 3.3.x or 3.4.0 is
recommended.

FortiOS Handbook for FortiOS 5.6.7
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FortiGate and FortiWiFi Models Earliest
FortiOS FortiSwitch Models

FGT and FWF-30D, 30D-POE, 30E
FGT and FWF-50E, 51E

FGR-60D
FGT-70D, 70D-POE

FGT-80D
FGR-90D

FGT and FWF-92D
FGT-94D-POE, 98D-POE

FGT-300D
FGT-400D
FGT-500D
FGT-600D
FGT-900D
FGT-1000D

FGT-3000D, 3100D, 3200D, 3240C, 3600C,
3810D, 3815D

FGT_VM, VM64, VM64-AWS, VM64-
AWSONDEMAND, VM64-HV, VM64-KVM, VM-

VMX, VM64-XEN

5.4.1

All FortiSwitch D-series models.

FortiSwitchOS 3.4.2 or later is required for
all managed switches.

FGT and FWF- 60E, 61E
FGT-100E, 101E 5.4.2

All FortiSwitch D-series models.

FortiSwitch 3.4.2 or later is required for all
managed switches.

FGT-80E, 80E-POE, 81E, 81E-POE
FGT-100EF 5.4.3

All FortiSwitch D-series models.

FortiSwitch 3.4.2 or later is required for all
managed switches.

FGT-90E, 91E
FGT-200E, 201E
FGT-2000E, 2500E

5.6.0

All FortiSwitch D-series models.

FortiSwitch 3.5.4 or later is required for all
managed switches.

FGT-500E 5.6.3

All FortiSwitch D-series and E-series
models.

FortiSwitch 3.6.0 or later is required for all
managed switches.

Refer to Managing a FortiSwitch with a FortiGate on page 2343 for details about the features supported on each
FortiSwitch model.

Before you begin
Before you start administrating your FortiSwitch unit, it is assumed that you have completed the initial
configuration of the FortiSwitch unit, as outlined in the QuickStart Guide for your FortiSwitch model and have
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administrative access to the FortiSwitch unit’s Web-based manager and CLI.

Whatʼs new for managed FortiSwitches in FortiOS 5.6.3 with FortiSwitch 3.6.3 (and later
releases)

This section describes new managed FortiSwitch features in FortiOS 5.6.3 with FortiSwitch 3.6.3.

Firewall policy now required for RADIUS traffic (434470)

In FortiLink mode, you must manually create a firewall policy to allow RADIUS traffic for 802.1x authentication
from the FortiSwitch (for example, from the FortiLink interface) to the RADIUS server through the FortiGate.

STP root guard (376015)

Enable root guard on all ports that should not be root bridges. Do not enable root guard on the root port. You must
have STP enabled to be able to use root guard.

Using the FortiGate GUI

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Right-click on a port.
3. Select Enable orDisable.

Using the FortiGate CLI

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set stp-root-guard {enabled | disabled}
end

end

STP BPDU guard (406182)

When BPDU guard is enabled on STP edge ports, any BPDUs received cause the ports to go down for a specified
number of minutes. The BPDUs are not forwarded, and the network edge is enforced.

There are two prerequisites for using BPDU guard:

l You must define the port as an edge port with the set edge-port enable command.
l You must enable STP on the switch interface with the set stp-state enabled command.

Using the FortiGate GUI

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Right-click on a port.
3. Select Enable orDisable.

Using the FortiGate CLI

config switch-controller managed-switch
edit <switch-id>

config ports

FortiOS Handbook for FortiOS 5.6.7
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edit <port name>
set stp-bpdu-guard {enabled | disabled}
set stp-bpdu-guard-time <0-120>

end
end

FortiSwitch log message changes (438738)

More details are now provided in exported FortiSwitch logs, for example:

l New Switch-Controller user field and daemon-name ui fields.
l Removed Switch-Controller keyword from the msg field
l Changed UpdSwConf keyword in msg field to FortiSwitch in flcfgd logs
l Removed the VDOM keyword from the msg field in flcfgd logs
l Removed the Fortiswitch keyword before SN in the msg field
l Changed syslog to have switch SN first followed by a space and then the first word following with a capital (in the

msg field)

Use the following CLI commands to enable the export of FortiSwitch logs and to set the level of logging included.
The system logs all messages at and above the logging severity level you select. For example, if you select
error, the system logs error, critical, alert, and emergency level messages.

config switch-controller switch-log
set status (*enable | disable)
set severity [emergency | alert | critical | error | warning | notification |

*information | debug]
end

Support FSW BPDU Guard (442921) (442922)

With standard STP, a device that sends BPDU(s) to any switch port becomes a member of that switch’s STP
network topology. In order to enforce a network edge, the access ports on the switch can be configured with
BPDU guard. With BPDU guard enabled, the port does not forward BPDUs upstream (toward its root bridge).
Instead, when a BPDU guard enabled port receives any BPDU, it immediately puts the port into a blocking state
and alerts the user.

This prevents the access port from accepting the downstream device, removing it from the receiving switch’s STP
calculations. In order to unblock the port after bpdu guard has triggered, the user must execute a reset command.
After the port is reset, it will resume normal operation and return to a blocking state only if another BPDU is
received.

BPDU guard is typically used in conjunction with Root Guard to enforce a specific network topology.

Syntax

config switch-controller managed-switch
edit <switch SN>

config ports
edit <port>

set stp-bpdu-guard <enable | *disable>
set stp-bpdu-guard-timeout <time> (0-120 in minutes)

next
end

next
end
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config switch-controller managed-switch
edit <switch SN>

config ports
edit <port>

set stp-root-guard <enable | *disable>
next

end
next

end

diagnose switch-controller dump stp <switch SN> <instance>
diagnose switch-controller bpdu-guard-status <switch SN>

Managed switch CLI features added to GUI (448722)

Added new optional columns "Edge Port", "LLDP Profile", "QoS Policy", "STP BPDU Guard", "STP Root Guard" in
WiFi & Switch Controller > FortiSwitch Ports.

This would allow administrators to make changes to the features above to multiple switch ports at the same time.

Added unit in help-text when setting max-rate/min-rate under switch-controller qos queue-
policy (449487) (449869)

Modified the CLI help-text on the FortiGate to show priority under strict schedule when setting max-rate/min-rate
under switch-controller qos queue-policy.

Syntax

set priority-0
queue-0 COS queue 0. (lowest priority)
queue-1 COS queue 1.
queue-2 COS queue 2.
queue-3 COS queue 3.
queue-4 COS queue 4.
queue-5 COS queue 5.
queue-6 COS queue 6.
queue-7 COS queue 7. (highest priority)

Added FortiSwitch factory-reset functionality to the FortiOS GUI (393205)

Added a Factory Reset button to theWiFi & Switch Controller > Managed FortiSwitch page when a
FortiSwitch document is selected.

Syntax

execute switch-controller factory-rest <switch sn>

Whatʼs new for managed FortiSwitches in FortiOS 5.6.1 with FortiSwitch 3.6.0 (and later
releases)

This section describes new managed FortiSwitch features in FortiOS 5.6.1 with FortiSwitch 3.6.0.
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Simplified method to convert a FortiSwitch to standalone mode (393205)

There is an easier way to convert a FortiSwitch from FortiLink mode to standalone mode so that it will no longer
be managed by a FortiGate:

l execute switch-controller factory-reset <switch-id>
This command returns the FortiSwitch to the factory defaults and then reboots the FortiSwitch. If the FortiSwitch is
configured for FortiLink auto-discovery, FortiGate can detect and automatically authorize the FortiSwitch.

l execute switch-controller set-standalone <switch-id>
This command returns the FortiSwitch to the factory defaults, reboots the FortiSwitch, and prevents the FortiGate
from automatically detecting and authorizing the FortiSwitch.

You can disable FortiLink auto-discovery on multiple FortiSwitches using the following commands:

config switch-controller global
set disable-discovery <switch-id>

end

You can also add or remove entries from the list of FortiSwitches that have FortiLink auto-discovery disabled
using the following commands:

config switch-controller global
append disable-discovery <switch-id>
unselect disable-discovery <switch-id>

end

Quarantines (410828)

Quarantined MAC addresses are blocked on the connected FortiSwitches from the network and the LAN.

NOTE: You must enable the quarantine feature in the FortiGate CLI using the set quarantine enable
command. You can add MAC addresses to the quarantine list before enabling the quarantine feature, but the
quarantine does not go into effect until enabled.

Quarantining a MAC address

Using the FortiGate GUI

1. Select the host to quarantine.
l Go to Security Fabric > Physical Topology, right-click on a host, and select Quarantine Host on
FortiSwitch.

l Go to Security Fabric > Logical Topology, right-click on a host, and select Quarantine Host on
FortiSwitch.

l Go to FortiView > Sources, right-click on an entry in the Source column, and select Quarantine Host
on FortiSwitch.

2. ClickOK to confirm that you want to quarantine the host.

Using the FortiGate CLI

config switch-controller quarantine
set quarantine enable

edit <MAC_address>
set description <string>
set tags <tag1 tag2 tag3 ...>

next
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next
end

Option Description

MAC_address A layer-2 MAC address in the following format: 12:34:56:aa:bb:cc

string Optional. A description of the MAC address being quarantined.

tag1 tag2 tag3 ... Optional. A list of arbitrary strings.

Viewing quarantine entries

Quarantine entries are created on the FortiGate that is managing the FortiSwitch.

Using the FortiGate GUI

1. Go toMonitor > Quarantine Monitor.
2. ClickQuarantined on FortiSwitch.

Using the FortiGate CLI

Use the following command to view the quarantine list of MAC addresses:

show switch-controller quarantine

When the quarantine feature is enabled on the FortiGate, it creates a quarantine VLAN (qtn.<FortiLink_port_
name>) on the virtual domain. The quarantine VLAN is applied to the allowed and untagged VLANs on all
connected FortiSwitch ports.

Use the following command to view the quarantine VLAN:

show system interface qtn.<FortiLink_port_name>

Use the following command to view how the quarantine VLAN is applied to the allowed and untagged VLANs on
all connected FortiSwitch ports:

show switch-controller managed-switch

Releasing MAC addresses from quarantine

Using the FortiGate GUI

1. Go toMonitor > Quarantine Monitor.
2. ClickQuarantined on FortiSwitch.
3. Right-click on one of the entries and select Delete orRemove All.
4. ClickOK to confirm your choice.

Using the FortiGate CLI

Use the following commands to delete a quarantined MAC address:

config switch-controller quarantine
config targets
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delete <MAC_address>
end

When the quarantine feature is disabled, all quarantined MAC addresses are released from quarantine. Use the
following commands to disable the quarantine feature:

config switch-controller quarantine
set quarantine disable

end

Assign untagged VLANs to a managed FortiSwitch port (410828)

Use the following commands to assign untagged VLANs to a managed FortiSwitch port:

config switch-controller managed-switch
edit <managed-switch>

config ports
edit <port>

set untagged-vlans <VLAN-name>
next

end
next

end

View, create, and assign multiple 802.1X policy definitions (408389 and 403901)

Previously, you could create one 802.1X policy for all managed FortiSwitches in a virtual domain. Now, you can
create multiple 802.1X policies and assign a different 802.1X policy to each managed FortiSwitch port.

View security policies for managed FortiSwitches

You can view security policies for managed FortiSwitches in two places:

l Go toWiFi & Switch Controller > FortiSwitch Security Policies.
l Go toWiFi & Switch Controller > FortiSwitch Ports and click the + next to a FortiSwitch. The security policy

for each port is listed in the Security Policy column.

Create and assign multiple 802.1X policy definitions for managed FortiSwitches

Previously, you could create one 802.1X policy for all managed FortiSwitches in a virtual domain. Now, you can
create multiple 802.1X policies and assign a different 802.1X policy to each managed FortiSwitch port.

To create an 802.1X security policy:

1. Go toWiFi & Switch Controller > FortiSwitch Security Policies.
2. ClickCreate New.
3. Enter a name for the new FortiSwitch security policy.
4. For the security mode, select Port-based orMAC-based.
5. Click + to select which user groups will have access.
6. Enable or disable guest VLANs on this interface to allow restricted access for some users.
7. Enter the number of seconds for authentication delay for guest VLANs. The range is 60-900 seconds.
8. Enable or disable authentication fail VLAN on this interface to allow restricted access for users who fail to access

the guest VLAN.
9. Enable or disable MAC authentication bypass (MAB) on this interface.
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10. Enable or disable EAP pass-through mode on this interface.
11. Enable or disable whether the session timeout for the RADIUS server will overwrite the local timeout.
12. ClickOK.
To apply an 802.1X security policy to a managed FortiSwitch port:

1. Go toWiFi & Switch Controller > FortiSwitch Ports.
2. Click the + next to a FortiSwitch.
3. In the Security Policy column for a port, click + to select a security policy.
4. ClickOK to apply the security policy to that port.

Override 802.1X settings

To override the 802.1X settings for a virtual domain:

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Click on a FortiSwitch faceplate and clickEdit.
3. In the Edit Managed FortiSwitch page, move theOverride 802-1X settings slider to the right.
4. In the Reauthentication Interval field, enter the number of minutes before reauthentication is required. The

maximum interval is 1,440 minutes. Setting the value to 0 minutes disables reauthentication.
5. In the Max Reauthentication Attempts field, enter the maximum times that reauthentication is attempted. The

maximum number of attempts is 15. Setting the value to 0 disables reauthentication.
6. Select Deauthenticate orNone for the link down action. Selecting Deauthenticate sets the interface to

unauthenticated when a link is down, and reauthentication is needed. Selecting Nonemeans that the interface
does not need to be reauthenticated when a link is down.

7. ClickOK.

Enable and disable switch-controller access VLANs through FortiGate (406718)

Access VLANs are VLANs that aggregate client traffic solely to the FortiGate. This prevents direct client-to-client
traffic visibility at the layer-2 VLAN layer. Clients can only communicate with the FortiGate. After the client traffic
reaches the FortiGate, the FortiGate can then determine whether to allow various levels of access to the client by
shifting the clientʼs network VLAN as appropriate.

Use enable to allow traffic only to and from the FortiGate and to block FortiSwitch port-to-port traffic on the
specified VLAN. Use disable to allow normal traffic on the specified VLAN.

config system interface
edit <VLAN name>

set switch-controller-access-vlan {enable | disable}
next

end

Override the admin password for all managed FortiSwitches (416261)

By default, each FortiSwitch has an admin account without a password. To replace the admin passwords for all
FortiSwitches managed by a FortiGate, use the following commands:

config switch-controller switch-profile
edit default

set login-passwd-override {enable | disable}
set login-passwd <password>

next
end
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If you had already applied a profile with the override enabled and the password set and then decide to remove the
admin password, you need to apply a profile with the override enabled and use the unset login-passwd
command; otherwise, your previously set password will remain in the FortiSwitch.

Configure an MCLAG with managed FortiSwitches (366617)

To configure a multichassis LAG (MCLAG) with managed FortiSwitches:

1. For each MCLAG peer switch, log into the FortiSwitch to create a LAG:

config switch trunk
edit "LAG-member"

set mode lacp-active
set mclag-icl enable
set members "<port>" "<port>"

next

2. Enable the MCLAG on each managed FortiSwitch:

config switch-controller managed-switch
edit "<switch-id>"

config ports
edit "<trunk name>"

set type trunk
set mode {static | lacp-passive | lacp-active}
set bundle {enable | disable}
set members "<port>,<port>"
set mclag {enable | disable}

next
end

next

3. Log into each managed FortiSwitch to check the MCLAG configuration:

diagnose switch mclag

After the FortiSwitches are configured as MCLAG peer switches, any port that supports advanced features on the
FortiSwitch can become a LAG port. When mclag is enabled and the LAG port names match, an MCLAG peer
set is automatically formed. The member ports for each FortiSwitch in the MCLAG do not need to be identical to
the member ports on the peer FortiSwitch.

Configure QoS with managed FortiSwitches (373581)

Quality of Service (QoS) provides the ability to set particular priorities for different applications, users, or data
flows. NOTE: FortiGate does not support QoS for hard or soft switch ports.

To configure the QoS for managed FortiSwitches:

1. Configure a Dot1p map.

config switch-controller qos dot1p-map
edit <Dot1p map name>

set description <text>
set priority-0 <queue number>
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set priority-1 <queue number>
set priority-2 <queue number>
set priority-3 <queue number>
set priority-4 <queue number>
set priority-5 <queue number>
set priority-6 <queue number>
set priority-7 <queue number>

next
end

2. Configure a DSCPmap.

config switch-controller qos ip-dscp-map
edit <DSCP map name>

set description <text>
configure map <map_name>

edit <entry name>
set cos-queue <COS queue number>
set diffserv {CS0 | CS1 | AF11 | AF12 | AF13 | CS2 | AF21 | AF22 | AF23

| CS3 | AF31 | AF32 | AF33 | CS4 | AF41 | AF42 | AF43 | CS5 | EF |
CS6 | CS7}

set ip-precedence {network-control | internetwork-control | critic-ecp
| flashoverride | flash | immediate | priority | routine}

set value <DSCP raw value>
next

end
end

3. Configure the egress QoS policy.

config switch-controller qos queue-policy
edit <QoS egress policy name>

set schedule {strict | round-robin | weighted}
config cos-queue
edit [queue-<number>]

set description <text>
set min-rate <rate in kbps>
set max-rate <rate in kbps>
set drop-policy {taildrop | random-early-detection}
set weight <weight value>
next

end
next

end

4. Configure the overall policy that will be applied to the switch ports.

config switch-controller qos qos-policy
edit <QoS egress policy name>

set default-cos <default CoS value 0-7>
set trust-dot1p-map <Dot1p map name>
set trust-ip-dscp-map <DSCP map name>
set queue-policy <queue policy name>

next
end
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5. Configure each switch port.

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port>

set qos-policy <CoS policy>
next

end
next

end

Reset PoE-enabled ports from the GUI (387417)

If you need to reset PoE-enabled ports, go toWiFi & Switch Control > FortiSwitch Ports, right-click on one
or more PoE-enabled ports and select Reset PoE from the context menu.

You can also go toWiFi & Switch Control > Managed FortiSwitch and click on a port icon for the FortiSwitch
of interest. In the FortiSwitch Ports page, right-click on one or more PoE-enabled ports and select Reset PoE
from the context menu.

Adding preauthorized FortiSwitches (382774)

After you preauthorize a FortiSwitch, you can assign the FortiSwitch ports to a VLAN.

To preauthorize a FortiSwitch:

1. Go toWiFi & Switch Controller >Managed FortiSwitch.
2. ClickCreate New.
3. In the New Managed FortiSwitch page, enter the serial number, model name, and description of the FortiSwitch.
4. Move the Authorized slider to the right.
5. ClickOK.

The Managed FortiSwitch page shows a FortiSwitch faceplate for the preauthorized switch.

What's new for managed FortiSwitches in FortiOS 5.6 with FortiSwitch 3.6.0 (and later
releases)

IGMP snooping (387515)

The GUI and CLI support the ability to configure IGMP snooping for managed switch ports.

To enable IGMP snooping from the GUI, go toWiFi & Switch Controller > FortiSwitch VLANs, edit a VLAN
and turn on IGMP Snooping underNetworked Devices.

From the CLI, start by enabling IGMP snooping on the FortiGate:

config switch-controller igmp-snooping
set aging-time <int>
set flood-unknown-multicast (enable | disable)

end

Then enable IGMP snooping on a VLAN:

config system interface
edit <vlan>

set switch-controller-igmp-snooping (enable | disable)
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end

Use the following command to enable IGMP snooping on switch ports, and to override the global parameters for
a specific switch.

config switch-controller managed-switch
edit <switch>

config ports
edit port <number>

set igmp-snooping (enable | disable)
set igmps-flood-reports (enable | disable)

next
config igmp-snooping globals

set aging-time <int>
set flood-unknown-multicast (enable | disable)

end
next

end

User-port link aggregation groups (378470)

The GUI now supports the ability to configure user port LAGs on managed FortiSwitches.

To create a link aggregation group for FortiSwitch user ports:

1. Go toWiFi & Switch Controller > FortiSwitch Ports
2. ClickCreate New > Trunk.
3. In the New Trunk Group page:

a. Enter a name for the trunk group
b. Select two or more physical ports to add to the trunk group
c. Select the mode: Static, Passive LACP, or Active LACP

4. ClickOK.

DHCP blocking, STP, and loop guard on managed FortiSwitch ports (375860)

The managed FortiSwitch GUI now supports the ability to enable/disable DHCP blocking, STP and loop guard for
FortiSwitch user ports.

Go to toWiFi & Switch Controller > FortiSwitch Ports. For any port you can select DHCP Blocking, STP, or
Loop Guard. STP is enabled on all ports by default. Loop guard is disabled by default on all ports.

Switch profile enhancements (387398)

Defaults switch profiles are bound to every switch discovered by the FortiGate. This means that an administrator
can establish a password for this profile or create a new profile and bind that profile to any switch. Consquently,
the password provided shall be configured on the FortiSwitch against the default "admin" account already
present.

Number of switches per FortiGate based on model (388024)

The maximum number of supported FortiSwitches depends on the FortiGate model:
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FortiGate Model Range Number of FortiSwitches Supported

Up to FortiGate-98 and FortiGate-VM01 8

FortiGate-100 to 280 and FortiGate-VM02 24

FortiGate-300 to 5xx 48

FortiGate-600 to 900 and FortiGate-VM04 64

FortiGate-1000 and up 128

FortiGate-3xxx and up, and FortiGate-VM08 and up 256

Miscellaneous configuration option changes

l The default value of dhcp-snooping (also called DHCP-blocking) is changed from trusted in FortiOS 5.4 to
untrusted in FortiOS 5.6.

l The default value of edge-port is changed from disabled in FortiOS 5.4 to enabled in FortiOS 5.6.0.
l The default value for DHCP snooping on the FortiLink VLAN (system interface) is changed from “enabled” in

FortiOS 5.6.2 and earlier to “disabled” in FortiOS 5.6.3 and later. Note that, in the GUI, DHCP snooping is
automatically changed to “enable” when the DHCP server is enabled on the interface.

Additional GUI support

l Link aggregation of FortiSwitch ports
l DHCP trusted/untrusted, loop guard, and STP for FortiSwitch ports
l Connect to CLI support for FortiSwitch

What's new for managed FortiSwitches in FortiOS 5.6 with FortiSwitch 3.5.4 (and later
releases)

This section describes new managed FortiSwitch features in FortiOS 5.6 with FortiSwitch 3.5.4.

Aggregating FortiSwitches into groups (397950)

In larger networks, the number of switches can be large. Different models and device purposes might exist.
Furthermore, the topology might have "built-in" redundancy. Use the following command to create a FortiSwitch
group allowing you to perform an operation on the entire group instead of one switch at a time.

config switch-controller switch-group
edit <name>

set description <string>
set members <..> <..>            
end

end

Pre-authentication and replacements of FortiSwitches (298533)

FortiSwitch configuration templates allow you to replace a FortiSwitch and have the configuration of the original
FortSwitch installed on the replacement.
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Use the execute replace-device fortiswitch <sn-old> <sn-new> to transfer the configuration
for the FortiSwitch with serial number <sn-old> to the replacement FortiSwitch with serial number <sn-new>.

LLDP MED on managed FortiSwitches (372288)

FortiOS 5.6 supports configuring link layer discovery protocol-media endpoint discovery (LLDPMED) for
managed FortiSwitches. Additionally, you can use FortiGate CLI commands display the information collected by
LLDP on the FortiSwitch.

You can use the following command to add media endpoint discovery (MED) features to an LLDP profile.

config switch-controller lldp-profile
edit <lldp-profle>

config med-network-policy
edit guest-voice

set status {disable | enable}
next
edit guest-voice-signaling

set status {disable | enable}
next
edit guest-voice-signaling

set status {disable | enable}
next
edit softphone-voice

set status {disable | enable}
next
edit streaming-video

set status {disable | enable}
next
edit video-conferencing

set status {disable | enable}
next
edit video-signaling

set status {disable | enable}
next
edit voice

set status {disable | enable}
next
edit voice-signaling

set status {disable | enable}
end

config custom-tlvs
edit <name>

set oui <identifier>
set subtype <subtype>
set information-string <string>

end
end

Enhanced 802.1x including FortiSwitch port security policy framework (389102)

New FortiSwitch port security features include:

l Dynamic VLAN Assignment
l “guest” and “auth-fail” VLAN
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l Mac Address Bypass (MAB)
l Multiple host support on single physical port

Global settings applied across the network

config switch-controller 802.1x-settings
set reauth-period < int >
set max-reauth-attempt < int >
set link-down-auth < *set-unauth | no-action >

end

Local switch overrides

config switch-controller managed-switch
edit < switch >

config 802.1x-settings
set local-override {disable | enable}
set reauth-period <int>                 
set max-reauth-attempt <int>             
set link-down-auth {set-unauth | no-action} 

end
next

end

Policy definitions (802.1x and captive-portal)

config switch-controller security-policy 802.1x
edit 8021X-policy-default

set user-group <user.group>
set mac-auth-bypas {disable | enable}
set guest-vlan {disable | enable}
set guest-vlanid <vlan-id>
set guest-auth-delay <int>
set auth-fail-vlan  {disable | enable}
set auth-fail-vlanid <vlan-id>
radius-timeout-overwrite {disable | enable}

end
end

config switch-controller security-policy captive-portal
edit captive-portal-default

set vlan <vlan-id>
config users

edit 1
set user-group <usergroup>
set vlanid <vlan-id>

next
end

end
end

Port settings

config switch-controller managed-switch
edit <managed-switch>
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config ports
edit <port>

set port-security-policy {802.1x-policy | captive-portal-policy}
next

end
next

end

Firmware upgrade management and compatible version information (385171)

You can view the current firmware version of a FortiSwitch and upgrade the FortiSwitch to a new firmware version
by going toWiFi & Switch Controller > Managed FortiSwitch and editing one of the FortiSwitches. Under
Firmware you can see the current firmware version and select Update to update it.

Changed managed-switch display format for 'dynamic-capability' (387239)

FortiOS 5.6.0 displays capability flags as strings such as: dynamic-capability, igmp-snooping, dhcp-snooping,
and so on. For example:

config switch-controller managed-switch
edit S124DP3X15000315
get
switch-id : S124DP3X15000315
name :
description :
fsw-wan1-peer : port9
fsw-wan1-admin : enable
fsw-wan2-peer :
fsw-wan2-admin : discovered
directly-connected : 0
connected : 1
version : 1
pre-provisioned : 0
dynamic-capability : igmp-snooping,dhcp-snooping
switch-device-tag :
dynamically-discovered: 1

Connecting to a managed switch CLI from the FortiGate GUI (378119)

To connect to a FortiSwitch CLI, go toWiFi & Switch Controller > Managed FortiSwitch, right click on the
FortiSwitch to connect to and select Connect to CLI. You can also open the FortiGate CLI console and use the
execute telnet <ip> command, where <ip> is the management IP address of the FortiSwitch.

Firmware upgrade of stacked or tiered switches (355050)

From your FortiGate CLI, you can upgrade the firmware of all of the managed FortiSwitches of the same model
using a single execute command. The command includes the name of a firmware image file and all of the
managed FortiSwitches compatible with that firmware image file are upgraded. For example:

execute switch-controller stage-tiered-swtp-image ALL <firmware-image-file>

You can also use the following new command to restart all of the managed FortiSwitches after a 2-minute delay.

execute switch-controller restart-swtp-delayed ALL
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More information displayed by the execute switch-controller get-conn-status command
(388751)

The get-conn-status command now displays more information for each managed switch including the ID of
each switch, the version of the firmware running on the switch, the status of the switch, the IP address for
managing the switch, and its join time.

execute switch-controller get-conn-status
Managed-devices in current vdom root:

STACK-NAME: FortiSwitch-Stack-port3
SWITCH-ID VERSION STATUS ADDRESS JOIN-TIME NAME
FS108D3W16001177 v3.4 Authorized/Down 169.254.1.2 N/A My-Switch

User-port link aggregation groups available on the GUI (378470)

The GUI now supports the ability to configure user port LAGs on managed FortiSwitches.

To create a link aggregation group for FortiSwitch user ports:

1. Go toWiFi & Switch Controller > FortiSwitch Ports.
2. ClickCreate New > Trunk.
3. In the New Trunk Group page enter a Name for the trunk group.
4. Select two or more physical ports to add to the trunk group.
5. Select theMode: Static, Passive LACP, or Active LACP.
6. Click OK.

DHCP blocking, STP, and loop guard on managed FortiSwitch ports on the GUI (375860)

The managed FortiSwitch GUI now supports the ability to enable/disable DHCP blocking, STP and loop guard for
FortiSwitch user ports.

Go toWiFi & Switch Controller > FortiSwitch Ports. For any port you can select DHCP Blocking, STP, or
Loop Guard. STP is enabled on all ports by default. Loop guard is disabled by default on all ports.
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New switch profiles (387398)

Switch profiles allow specific settings to be applied to all authorized FortiSwitches. The default switch profile is
automatically bound to every switch discovered by the FortiGate. You can create additional profiles as needed.

Within a switch profile, you can control the behavior of the FortiSwitch’s admin account.You can add a password
to a profile or create a new profile and bind that profile to any switch. The password provided in the profile is
configured on the FortiSwitch to the default admin administrator account.

Miscellaneous configuration option changes

l On a switch port, the default value of dhcp-snooping (also called DHCP-blocking) is changed from trusted in
FortiOS 5.4 to untrusted in FortiOS 5.6.

l On a switch port, the default value of STP edge-port is changed from disabled in FortiOS 5.4 to enabled in
FortiOS 5.6.0.

l The default value of fortilink-split-port is changed from disable in FortiOS 5.4.1/5.4.2 to enable in
FortiOS 5.4.3 onward. This command applies to FortiGate aggregate interfaces.

config system interface
edit <name of the FortiLink interface>

set fortilink-split-interface enable
end

l The default value for DHCP snooping on the FortiLink VLAN (system interface) is changed from “enabled” in
FortiOS 5.6.2 and earlier to “disabled” in FortiOS 5.6.3 and later. Note that, in the GUI, DHCP snooping is
automatically changed to “enable” when the DHCP server is enabled on the interface.
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Before you begin
Before you configure the managed FortiSwitch unit, the following assumptions have been made in the writing of
this manual:

l You have completed the initial configuration of the FortiSwitch unit, as outlined in the QuickStart Guide for your
FortiSwitch, and you have administrative access to the FortiSwitch Web-based manager and CLI.

l You have installed a FortiGate unit on your network and have administrative access to the FortiGate Web-based
manager and CLI.

How this guide is organized
This guide contains the following sections:

l Connecting FortiLink ports - information about connecting FortiSwitch ports to FortiGate ports.
l FortiLink configuration using the FortiGate GUI
l FortiLink configuration using the FortiGate CLI
l Network topologies for managed FortiSwitches - describes the configuration for various stacking topologies.
l Optional setup tasks - describes other setup tasks.
l FortiSwitch features configuration - describes configuring managed FortiSwitch features including VLANs.
l FortiSwitch port features - configure ports and PoE from the FortiGate unit.
l FortiSwitch port security policy - describes setting up FortiSwitch security policies.
l Additional capabilities - describes extra FortiSwitch features.
l Troubleshooting - describes techniques for troubleshooting common problems.
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Connecting FortiLink ports

This section contains information about the FortiSwitch and FortiGate ports that you connect to establish a
FortiLink connection.

For all FortiGate models, you can connect up to 16 FortiSwitches to one FortiGate unit.

In FortiSwitchOS 3.3.0 and later releases, you can use any of the switch ports for FortiLink. Some or all of the
switch ports (depending on the model) support auto-discovery of the FortiLink ports.

You can chose to connect a single FortiLink port or multiple FortiLink ports as a logical interface (link-aggregation
group, hardware switch, or software switch).

1. Enable the switch controller on FortiGate
Before connecting the FortiSwitch and FortiGate units, ensure that the switch controller feature is enabled on the
FortiGate with the FortiGate Web-based manager or CLI to enable the switch controller. Depending on the
FortiGate model and software release, this feature may be enabled by default.

Using the FortiGate GUI

1. Go to System > Feature Visibility.
2. Turn on the Switch Controller feature, which is in the Basic Features list.
3. Select Apply.
The menu optionWiFi & Switch Controller now appears.

Using the FortiGate CLI

Use the following commands to enable the Switch Controller:

config system global
set switch-controller enable

end

2. Connect the FortiSwitch and FortiGate
FortiSwitchOS 3.3.0 and later provides flexibility for FortiLink:

l Use any switch port for FortiLink
l Provides auto-discovery of the FortiLink ports on the FortiSwitch
l Choice of a single FortiLink port or multiple FortiLink ports in a link-aggregation group (LAG)

Auto-discovery of the FortiSwitch ports

In FortiSwitchOS 3.3.0 and later releases, D-series FortiSwitch models support FortiLink auto-discovery, on
automatic detection of the port connected to the FortiGate.

You can use any of the switch ports for FortiLink. Before connecting the switch to the FortiGate, use the following
FortiSwitch CLI commands to configure a port for FortiLink auto-discovery:

config switch interface
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edit <port>
set auto-discovery-fortilink enable

end

By default, each FortiSwitch model provides a set of ports that are enabled for FortiLink auto-discovery. If you
connect the FortiLink using one of these ports, no switch configuration is required.

In FortiSwitchOS 3.4.0 and later releases, the last four ports are the default auto-discovery FortiLink ports. You
can also run the show switch interface command on the FortiSwitch to see the ports that have auto-discovery
enabled.

The following table lists the default auto-discovery ports for each switch model. NOTE: Any port can be used for
FortiLink if it is manually configured.

FortiSwitch Model Default Auto-FortiLink ports

FS-108D ports 9 and 10

FS-108D-POE ports 9 and 10

FSR-112D ports 9, 10, 11 and 12

FSR-112D-POE ports 5, 6, 7, 8, 9, 10, 11, and 12

FS-124D, FS-124D-POE ports 23, 24, 25, and 26

FS-224D-POE ports 21, 22, 23, and 24

FS-224D-FPOE ports 21, 22, 23, 24, 25, 26, 27, and 28

FS-248D, FS-248D-FPOE, FS-448D, FS-
448D-FPOE, FS-448D-POE ports 45, 46, 47, 48, 49, 50, 51, and 52

FS-248D-POE ports 47, 48, 49, and 50

FS-424D, FS-424D-POE, FS-424D-FPOE ports 23, 24, 25, and 26

FS-524D, FS-524D-FPOE ports 21, 22, 23, 24, 25, 26, 27, 28, 29, and 30

FS-548D, FS-548D-FPOE ports 45, 46, 47, 48, 49, 50, 51, 52, 53, and 54

FS-1024D, FS-1048D, FS-3032D all ports

Choosing the FortiGate ports

The FortiGate manages all of the switches through one active FortiLink. The FortiLink may consist of one port or
multiple ports (for a LAG).

As a general rule, FortiLink is supported on all ports that are not listed as HA ports.
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FortiLink configuration using the FortiGate GUI

This section describes how to configure a FortiLink between a FortiSwitch and a FortiGate.

You can configure FortiLink using the FortiGate GUI or CLI. Fortinet recommends using the GUI because the
CLI procedures are more complex (and therefore more prone to error).

If you use one of the auto-discovery FortiSwitch ports, you can establish the FortiLink connection (single port or
LAG) with no configuration steps on the FortiSwitch and with a few simple configuration steps on the FortiGate.

Summary of the procedure
1. On the FortiGate, configure the FortLink port or create a logical FortLink interface.
2. Authorize the managed FortiSwitch.

Configure FortiLink as a single link

To configure the FortiLink port on the FortiGate:

1. Go to Network > Interfaces.
2. (Optional) If the FortiLink physical port is currently included in the internal interface, edit it and remove the desired

port from the Physical Interface Members.
3. Edit the FortiLink port.
4. Set Addressing mode to Dedicated to FortiSwitch.
5. Configure the IP/Network Mask for your network.
6. Optionally select Automatically authorize devices or disable to manually authorize the FortiSwitch.
7. Select OK.

Configure FortiLink as a logical interface

You can configure the FortiLink as a logical interface: link-aggregation group (LAG), hardware switch, or software
switch).

LAG is supported on all FortiSwitch models and on FortiGate models FGT-100D and above. Hardware switch is
supported on some FortiGate models.

Connect any of the FortiLink-capable ports on the FortiGate to the FortiSwitch. Ensure that you configure auto-
discovery on the FortiSwitch ports (unless it is so by default).

1. Go to Network > Interfaces.
2. (Optional) If the FortiLink physical ports are currently included in the internal interface, edit the internal interface,

and remove the desired ports from the Physical Interface Members.
3. Select Create New > Interface.
4. Enter a name for the interface (11 characters maximum).
5. Set the Type to 802.3ad Aggregate, Hardware Switch, or Software Switch.
6. Select the FortiGate ports for the logical interface.
7. Set Addressing mode to Dedicated to FortiSwitch.
8. Configure the IP/Network Mask for your network.
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9. Optionally select Automatically authorize devices or disable to manually authorize the FortiSwitch.
10. Select OK.

FortiLink split interface
You can use the FortiLink split interface to connect the FortiLink aggregate interface from one FortiGate to two
FortiSwitches. When the FortiLink split interface is enabled, only one link remains active.

The aggregate interface for this configuration must contain exactly two physical ports (one for each FortiSwitch).

You must enable the split interface on the FortiLink aggregate interface using the FortiGate CLI:

config system interface
edit <name of the FortiLink interface>

set fortilink-split-interface enable
end

Authorizing the FortiSwitch
If you configured the FortiLink interface to manually authorize the FortiSwitch as a managed switch, perform the
following steps:

1. Go toWiFi & Switch Controller >Managed FortiSwitch.
2. Optionally, click on the FortiSwitch faceplate and clickAuthorize. This step is required only if you disabled the

automatic authorization field of the interface.

Adding preauthorized FortiSwitches
After you preauthorize a FortiSwitch, you can assign the FortiSwitch ports to a VLAN.

To preauthorize a FortiSwitch:

1. Go toWiFi & Switch Controller >Managed FortiSwitch.
2. ClickCreate New.
3. In the New Managed FortiSwitch page, enter the serial number, model name, and description of the FortiSwitch.
4. Move the Authorized slider to the right.
5. ClickOK.

The Managed FortiSwitch page shows a FortiSwitch faceplate for the preauthorized switch.
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Managed FortiSwitch display
Go toWiFi & Switch Controller >Managed FortiSwitch to see all of the switches being managed by your
FortiGate.

When the FortiLink is established successfully, the status is green (next to the FortiGate interface name and on
the FortiSwitch faceplate), and the link between the ports is a solid line.

If the link has gone down for some reason, the line will be dashed, and a broken link icon will appear. You can still
edit the FortiSwitch though and find more information about the status of the switch. The link to the FortiSwitch
may be down for a number of reasons; for example, a problem with the cable linking the two devices, firmware
versions being out of synch, and so on. You need to make sure the firmware running on the FortiSwitch is
compatible with the firmware running on the FortiGate.

From the Managed FortiSwitch page, you can edit any of the managed FortiSwitches, remove a FortiSwitch from
the configuration, refresh the display, connect to the CLI of a FortiSwitch, or deauthorize a FortiSwitch.

Edit a managed FortiSwitch
To edit a managed FortiSwitch:

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Click on the FortiSwitch to and clickEdit, right-click on a FortiSwitch and select Edit, or double-click on a

FortiSwitch.

From the Edit Managed FortiSwitch form, you can:

l Change the Name and Description of the FortiSwitch.
l View the Status of the FortiSwitch.
l Restart the FortiSwitch.
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l Authorize or deauthorize the FortiSwitch.
l Update the firmware running on the switch.

Network interface display
On the Network > Interfaces page, you can see the FortiGate interface connected to the FortiSwitch. The GUI
indicatesDedicated to FortiSwitch in the IP/Netmask field.

Add link aggregation groups (Trunks)
To create a link aggregation group for FortiSwitch user ports:

1. Go toWiFi & Switch Controller > FortiSwitch Ports.
2. ClickCreate New > Trunk.
3. In the New Trunk Group page, enter a Name for the trunk group.
4. Select two or more physical ports to add to the trunk group.
5. Select theMode: Static, Passive LACP, or Active LACP.
6. ClickOK.

Configure DHCP blocking, IGMP snooping, STP, and loop guard on managed FortiSwitch
ports

Go toWiFi & Switch Controller > FortiSwitch Ports. Right-click any port and then enable or disable the
following features:
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l DHCP blocking—The DHCP blocking feature monitors the DHCP traffic from untrusted sources (for example,
typically host ports and unknown DHCP servers) that might initiate traffic attacks or other hostile actions. To prevent
this, DHCP blocking filters messages on untrusted ports.

l IGMP snooping—IGMP snooping allows the FortiSwitch to passively listen to the Internet Group Management
Protocol (IGMP) network traffic between hosts and routers. The switch uses this information to determine which
ports are interested in receiving each multicast feed. FortiSwitch can reduce unnecessary multicast traffic on the
LAN by pruning multicast traffic from links that do not contain a multicast listener.

l Spanning Tree Protocol (STP)—STP is a link-management protocol that ensures a loop-free layer-2 network
topology.

l Loop guard—A loop in a layer-2 network results in broadcast storms that have far-reaching and unwanted effects.
Fortinet loop guard helps to prevent loops. When loop guard is enabled on a switch port, the port monitors its
subtending network for any downstream loops. The loop guard feature is designed to work in concert with STP
rather than as a replacement for STP.

l STP root guard—Root guard protects the interface on which it is enabled from becoming the path to root. When
enabled on an interface, superior BPDUs received on that interface are ignored or dropped. Without using root
guard, any switch that participates in STPmaintains the ability to reroute the path to root. Rerouting might cause
your network to transmit large amounts of traffic across suboptimal links or allow a malicious or misconfigured
device to pose a security risk by passing core traffic through an insecure device for packet capture or inspection. By
enabling root guard on multiple interfaces, you can create a perimeter around your existing paths to root to enforce
the specified network topology.

l STP BPDU guard—Similar to root guard, BPDU guard protects the designed network topology. When BPDU
guard is enabled on STP edge ports, any BPDUs received cause the ports to go down for a specified number of
minutes. The BPDUs are not forwarded, and the network edge is enforced.

STP is enabled on all ports by default. Loop guard is disabled by default on all ports.
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FortiLink configuration using the FortiGate CLI

This section describes how to configure FortiLink using the FortiGate CLI. Fortinet recommends using the
FortiGate GUI because the CLI procedures are more complex (and therefore more prone to error).

If you use one of the auto-discovery FortiSwitch ports, you can establish the FortiLink connection (single port or
LAG) with no configuration steps on the FortiSwitch and with a few simple configuration steps on the FortiGate.

Summary of the procedure
1. Remove the port(s) from the LAN interface.
2. Configure the FortLink port or create a logical FortLink interface if it is required on the model you are using.
3. Configure NTP.
4. Authorize the managed FortiSwitch.
5. Configure DHCP.

Configure FortiLink as a single link
Configure the FortiLink port on the FortiGate and authorize the FortiSwitch as a managed switch.

In the following steps, port 1 is configured as the FortiLink port.

1. If required, remove port 1 from the lan interface:
config system virtual-switch

edit lan
config port

delete port1
end

end
end

2. Configure port 1 as the FortiLink interface:
config system interface

edit port1
set auto-auth-extension-device enable
set fortilink enable

end
end

3. Configure an NTP server on port 1:
config system ntp

set server-mode enable
set interface port1

end

4. Authorize the FortiSwitch unit as a managed switch.
config switch-controller managed-switch

edit FS224D3W14000370
set fsw-wan1-admin enable

end
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end

NOTE: FortiSwitch will reboot when you issue the set fsw-wan1-admin enable command.

Configure FortiLink as a logical interface
You can configure the FortiLink as a logical interface: link-aggregation group (LAG), hardware switch, or software
switch).

NOTE: LAG is supported on all FortiSwitch models and on FortiGate models FGT-100D and above. Hardware switch
is supported on some FortiGate models.

Connect any of the FortiLink-capable ports on the FortiGate to the FortiSwitch. Ensure that you configure auto-
discovery on the FortiSwitch ports (unless it is auto-discovery by default).

In the following procedure, port 4 and port 5 are configured as a FortiLink LAG.

1. If required, remove the FortiLink ports from the lan interface:
config system virtual-switch

edit lan
config port

delete port4
delete port5

end
end

end

2. Create a trunk with the two ports that you connected to the switch:
config system interface

edit flink1 (enter a name, 11 characters maximum)
set allowaccess ping capwap https
set vlanforward enable
set type aggregate
set member port4 port5
set lacp-mode static
set fortilink enable
(optional) set fortilink-split-interface enable

next
end

NOTE: If the members of the aggregate interface connect to more than one FortiSwitch, you must enable fortilink-
split-interface.

3. Authorize the FortiSwitch unit as a managed switch.
config switch-controller managed-switch

edit FS224D3W14000370
set fsw-wan1-admin enable

end
end

NOTE: FortiSwitch will reboot when you issue the set fsw-wan1-admin enable command.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2371



Network topologies for managed FortiSwitches

Network topologies for managed FortiSwitches

The FortiGate requires only one active FortiLink to manage all of the subtending FortiSwitches (called stacking).

You can configure the FortiLink as a physical interface or as a logical interface (associated with one or more
physical interfaces). Depending on the network topology, you may also configure a standby FortiLink.

For any of the topologies, note the following:

l All of the managed FortiSwitches will function as one Layer-2 stack where the FortiGate manages each FortiSwitch
separately.

l The active FortiLink carries data as well as management traffic.

Supported topologies
Fortinet recommends the following topologies for managed FortiSwitches:

l Single FortiGate managing a single FortiSwitch
l Single FortiGate managing a stack of several FortiSwitches
l HA-mode FortiGates managing a single FortiSwitch
l HA-mode FortiGates managing a stack of several FortiSwitches
l HA-mode FortiGates managing a FortiSwitch two-tier topology
l Single FortiGate managing multiple FortiSwitches (using a hardware or software switch interface)
l HA-mode FortiGates managing two-tier FortiSwitches with access rings
l Dual-homed servers connected to FortiLink tier-1 FortiSwitches using an MCLAG
l Standalone FortiGate with dual-homed FortiSwitch access
l HA-mode FortiGates with dual-homed FortiSwitch access

Single FortiGate managing a single FortiSwitch
On the FortiGate, the FortiLink interface is configured as physical or aggregate. The 802.3ad aggregate interface
type provides a logical grouping of one or more physical interfaces.

NOTE: For the aggregate interface, you must disable the split interface on the FortiGate.
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Single FortiGate managing a stack of several FortiSwitches
The FortiGate connects directly to one FortiSwitch device using a physical or aggregate interface. The remaining
FortiSwitches connect in a ring using inter-switch links (that is, ISL).

Optionally, you can connect a standby FortiLink connection to the last FortiSwitch. For this configuration, you
create a FortiLink Split-Interface (an aggregate interface that contains one active link and one standby link).

HA-mode FortiGates managing a single FortiSwitch
The master and slave FortiGate units both connect a FortiLink to the FortiSwitch. The FortiLink port(s) and
interface type must match on the two FortiGate units.
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HA-mode FortiGates managing a stack of several FortiSwitches
The master and slave FortiGate units both connect a FortiLink to the first FortiSwitch and (optionally) to the last
FortiSwitch. The FortiLink ports and interface type must match on the two FortiGate units.

For the active/standby FortiLink configuration, you create a FortiLink Split-Interface (an aggregate interface that
contains one active link and one standby link).

HA-mode FortiGates managing a FortiSwitch two-tier topology
The distribution FortiSwitch connects to the master and slave FortiGate units. The FortiLink port(s) and interface
type must match on the two FortiGate units.
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Single FortiGate managing multiple FortiSwitches (using a hardware or software switch
interface)

The FortiGate connects directly to each FortiSwitch. Each of these FortiLink ports is added to the logical
hardware-switch or software-switch interface on the FortiGate.

Optionally, you can connect other devices to the FortiGate logical interface. These devices, which must support
IEEE 802.1q VLAN tagging, will have Layer 2 connectivity with the FortiSwitch ports.

NOTE: Using the hardware or software switch interface in FortiLink mode is not recommended in most cases. It can
be used when the traffic on the ports is very light because all traffic across the switches moves through FortiGate.
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HA-mode FortiGates managing two-tier FortiSwitches with access rings
NOTE: MCLAG is not supported when access rings are present.

HA-mode FortiGates connect to redundant distribution FortiSwitches. Access FortiSwitches are arranged in a
stack in each IDF, connected to both distribution switches.

For the FortiLink connection to each distribution switch, you create a FortiLink split interface (an aggregate
interface that contains one active link and one standby link).
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Dual-homed servers connected to FortiLink tier-1 FortiSwitches using an MCLAG
To configure a multichassis LAG, you need to configure FortiSwitch 1 and FortiSwitch 2 as MCLAG peer switches
before creating a two-port LAG. Use the set mclag-icl enable command to create an inter-chassis link
(ICL) on each FortiSwitch. Then you set up two MCLAGs towards the servers, each MCLAG using one port from
each FortiSwitch. You must disable the FortiLink split interface for the FortiGate.

This topology is supported when the FortiGate is in HAmode.

Standalone FortiGate with dual-homed FortiSwitch access
This network topology provides high port density with two tiers of FortiSwitches.

Use the set mclag-icl enable command to create an ICL on each FortiSwitch.
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HA-mode FortiGates with dual-homed FortiSwitch access
In HAmode, only one FortiGate is active at a time. If the active FortiGate fails, the backup FortiGate becomes
active.

Use the set mclag-icl enable command to create an ICL on each FortiSwitch.

Grouping FortiSwitches
You can simplify the configuration and management of complex topologies by creating FortiSwitch groups. A
group can include one or more FortiSwitches and you can include different models in a group.

config switch-controller switch-group
edit <name>

set description <string>
set members <serial-number> <serial-number> ...
end

end

Grouping FortiSwitches allows you to restart all of the switches in the group instead of individually. For example,
you can use the following command to restart all of the FortiSwitches in a group named my-sw-group:

execute switch-controller restart-swtp my-switch-group

Upgrading the firmware of FortiSwitch groups is easier, too, because fewer commands are needed. See
Firmware upgrade of stacked or tiered FortiSwitches on page 2380.

Stacking configuration

To set up stacking:

1. Configure the active FortiLink interface on the FortiGate.
2. (Optional) Configure the standby FortiLink interface.
3. Connect the FortiSwitches together, based on your chosen topology.

2378 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Network topologies for managed FortiSwitches

1. Configure the active FortiLink

Configure the FortiLink interface (as described in the FortiLink configuration using the FortiGate GUI chapter).

When you configure the FortiLink interface, the stacking capability is enabled automatically.

2. Configure the standby FortiLink

Configure the standby FortiLink interface. Depending on your configuration, the standby FortiLink might connect
to the same FortiGate as the active FortiLink or to a different FortiGate.

If the FortiGate receives discovery requests from two FortiSwitches, the link from one FortiSwitch will be selected
as active, and the link from other FortiSwitch will be selected as standby.

If the active FortiLink fails, FortiGate converts the standby FortiLink to active.

3. Connect the FortiSwitches

Refer to the topology diagrams to see how to connect the FortiSwitches.

Inter-switch links (ISLs) form automatically between the stacked switches.

FortiGate will discover and authorize all of the FortiSwitches that are connected. After this, the FortiGate is ready
to manage all of the authorized FortiSwitches.

Disable stacking

To disable stacking, execute the following commands from the FortiGate CLI. In the following example, port4 is
the FortiLink interface:

config system interface
edit port4

set fortilink-stacking disable
end

end
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Firmware upgrade of stacked or tiered FortiSwitches

In this topology, the core FortiSwitches are model FS-224D-FPOE, and the access FortiSwitches are model FS-
124D-POE. Because the switches are stacked or tiered, the procedure to update the firmware is simpler. In the
following procedure, the four FortiSwitches are upgraded from 3.6.1 to 3.6.2.

To upgrade the firmware of stacked or tiered FortiSwitches:

1. Check that all of the FortiSwitches are connected and which firmware versions they are running. For example:

FG100E4Q16004478 (root) # execute switch-controller get-conn-status
Managed-devices in current vdom root:

STACK-NAME: FortiSwitch-Stack-flink
SWITCH-ID VERSION STATUS ADDRESS JOIN-TIME
NAME
S124DP3X15000118 v3.6.1 Authorized/Up 169.254.1.5 Mon Oct 2 14:06:08 2017 -
S124DP3X15000380 v3.6.1 Authorized/Up 169.254.1.4 Mon Oct 2 14:05:26 2017 -
S224DF3X16001718 v3.6.1 Authorized/Up 169.254.1.3 Mon Oct 2 14:05:37 2017 -
S224DF3X17000238 v3.6.1 Authorized/Up 169.254.1.2 Mon Oct 2 14:06:22 2017 -
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2. Upload the firmware image for each FortiSwitch model (FS-224D-FPOE and FS-124D-POE) from either an FTP or
TFTP server. If you are using a virtual domain (VDOM), you must enter the config global command before
entering the upload-swtp-image command. For example:

FG100E4Q16004478 (global) # execute switch-controller upload-swtp-image tftp FSW_124D_POE-
v3-build0382-FORTINET.out 172.30.12.18

Downloading file FSW_124D_POE-v3-build0382-FORTINET.out from tftp server 172.30.12.18...
##################
Image checking ...
Image MD5 calculating ...
Image Saving S124DP-IMG.swtp ...
Successful!

File Syncing...

FG100E4Q16004478 (global) # execute switch-controller upload-swtp-image tftp FSW_224D_FPOE-
v3-build0382-FORTINET.out 172.30.12.18

Downloading file FSW_224D_FPOE-v3-build0382-FORTINET.out from tftp server 172.30.12.18...
######################
Image checking ...
Image MD5 calculating ...
Image Saving S224DF-IMG.swtp ...
Successful!

File Syncing...

3. Check which firmware images are available. For example:

FG100E4Q16004478 (root) # execute switch-controller list-swtp-image
SWTP Images on AC:
ImageName ImageSize(B) ImageInfo ImageMTime
S124DP-IMG.swtp 19174985 S124DP-v3.6-build382 Mon Oct 2 14:40:54 2017
S224DF-IMG.swtp 23277106 S224DF-v3.6-build382 Mon Oct 2 14:42:55 2017

4. Stage the firmware image for each FortiSwitch model (FS-224D-FPOE and FS-124D-POE). For example:

FG100E4Q16004478 (root) # execute switch-controller stage-tiered-swtp-image ALL S124DP-
IMG.swtp
Staged Image Version S124DP-v3.6-build382

FG100E4Q16004478 (root) # execute switch-controller stage-tiered-swtp-image ALL S224DF-
IMG.swtp
Staged Image Version S224DF-v3.6-build382

5. Check that the correct firmware image is staged for each FortiSwitch. For example:

FG100E4Q16004478 (root) # diagnose switch-controller dump network-upgrade status
Device State

===========================================================================================
================================
VDOM : root
S224DF3X16001718 Running : S224DF-v3.6.1-build372,170620 (GA)
Next Boot : S224DF-v3.6-build382, Flash Erase:[100], Flash Write:[100]
S224DF3X17000238 Running : S224DF-v3.6.1-build372,170620 (GA)
Next Boot : S224DF-v3.6-build382, Flash Erase:[100], Flash Write:[100]
S124DP3X15000118 Running : S124DP-v3.6.1-build372,170620 (GA)
Next Boot : S124DP-v3.6-build382, Flash Erase:[100], Flash Write:[100]
S124DP3X15000380 Running : S124DP-v3.6.1-build372,170620 (GA)
Next Boot : S124DP-v3.6-build382, Flash Erase:[100], Flash Write:[100]

6. Restart the FortiSwitches after a 2-minute delay. For example:

execute switch-controller restart-swtp-delayed ALL

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2381



Network topologies for managed FortiSwitches

7. When the FortiSwitches are running again, check that they are running the new firmware version. For example:

execute switch-controller get-conn-status
Managed-devices in current vdom root:

STACK-NAME: FortiSwitch-Stack-flink
SWITCH-ID VERSION STATUS ADDRESS JOIN-TIME
NAME
S124DP3X15000118 v3.6.2 Authorized/Up 169.254.1.5 Mon Oct 2 15:26:51 2017 -
S124DP3X15000380 v3.6.2 Authorized/Up 169.254.1.4 Mon Oct 2 15:26:49 2017 -
S224DF3X16001718 v3.6.2 Authorized/Up 169.254.1.3 Mon Oct 2 15:25:44 2017 -
S224DF3X17000238 v3.6.2 Authorized/Up 169.254.1.2 Mon Oct 2 15:25:27 2017 -

Transitioning from a FortiLink split interface to a FortiLink MCLAG
In this topology, the FortiLink split interface connects a FortiLink aggregate interface from one FortiGate to two
FortiSwitches.

Note the following:

l This procedure also applies to a FortiGate in HAmode.
l More links can be added between the FortiGate and FortiSwitch.
l After the MCLAG is set up, only connect the tier-2 FortiSwitches.

1. Enable the split interface on the FortiLink aggregate interface. By default, the split interface is enabled. For
example:

config system interface
edit flinksplit1

set ip 169.254.3.1 255.255.255.0
set allowaccess ping capwap https
set vlanforward enable
set type aggregate
set member port4 port5
set lacp-mode static
set fortilink enable
set fortilink-split-interface enable

next
end
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2. Log into FortiSwitch 2 using the Connect to CLI button in the FortiGate GUI, use the get switch lldp
auto-isl-status command to find out the name of the trunk connecting the peer switches, and change the
ISL to an ICL. For example:

get switch lldp auto-isl-status

config switch trunk
edit <trunk_name>

set mclag-icl enable
next

end

3. Log into FortiSwitch 1 using the Connect to CLI button in the FortiGate GUI, use the get switch lldp
auto-isl-status command to find out the name of the trunk connecting the peer switches, and change the
ISL to an ICL. For example:

get switch lldp auto-isl-status

config switch trunk
edit <trunk_name>

set mclag-icl enable
next

end

4. Log into the FortiGate and disable the split interface. For example:

config system interface
edit flinksplit1

set fortilink-split-interface disable
next

end

5. Enable the LACP active mode.
6. Check that the LAG is working correctly. For example:

diagnose netlink aggregate name <aggregate_name>
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Optional setup tasks

This section describes the following tasks:

l Configuring the FortiSwitch management port
l Converting to the FortiSwitch standalone mode
l Changing the admin password on the FortiGate for all managed FortiSwitches

Configuring the FortiSwitch management port
If the FortiSwitch model has a dedicated management port, you can configure remote management to the
FortiSwitch. In FortiLink mode, the FortiGate is the default gateway, so you need to configure an explicit route for
the FortiSwitch management port.

Using the Web administration GUI

1. Go to Network > Static Routes >Create New > Route.
2. Set Destination to Subnet and enter a subnetwork and mask.
3. Set Device to the management interface.
4. Add aGateway IP address.

Using the FortiSwitch CLI

Enter the following commands:

config router static
edit 1

set device mgmt
set gateway <router IP address>
set dst <router subnet> <subnet mask>

end
end

In the following example, the FortiSwitch management port is connected to a router with IP address
192.168.0.10:

config router static
edit 1

set device mgmt
set gateway 192.168.0.10
set dst 192.168.0.0 255.255.0.0

end
end

Converting to FortiSwitch standalone mode
Use one of the following commands to convert a FortiSwitch from FortiLink mode to standalone mode so that it
will no longer be managed by a FortiGate:
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l execute switch-controller factory-reset <switch-id>
This command returns the FortiSwitch to the factory defaults and then reboots the FortiSwitch. If the FortiSwitch is
configured for FortiLink auto-discovery, FortiGate can detect and automatically authorize the FortiSwitch. For
example:
execute switch-controller factory-reset S1234567890

l execute switch-controller set-standalone <switch-id>
This command returns the FortiSwitch to the factory defaults, reboots the FortiSwitch, and prevents the FortiGate
from automatically detecting and authorizing the FortiSwitch. For example:
execute switch-controller set-standalone S1234567890

You can disable FortiLink auto-discovery on multiple FortiSwitches using the following commands:

config switch-controller global
set disable-discovery <switch-id>

end

For example:

config switch-controller global
set disable-discovery S1234567890

end

You can also add or remove entries from the list of FortiSwitches that have FortiLink auto-discovery disabled
using the following commands:

config switch-controller global
append disable-discovery <switch-id>
unselect disable-discovery <switch-id>

end

For example:

config switch-controller global
append disable-discovery S012345678
unselect disable-discovery S1234567890

end

Changing the admin password on the FortiGate for all managed FortiSwitches
By default, each FortiSwitch has an admin account without a password. To replace the admin passwords for all
FortiSwitches managed by a FortiGate, use the following commands from the FortiGate CLI:

config switch-controller switch-profile
edit default

set login-passwd-override {enable | disable}
set login-passwd <password>

next
end

If you had already applied a profile with the override enabled and the password set and then decide to remove the
admin password, you need to apply a profile with the override enabled and no password set; otherwise, your
previously set password will remain in the FortiSwitch. For example:

config switch-controller switch-profile
edit default
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set login-passwd-override enable
unset login-passwd

next
end
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FortiSwitch port features

You can configure the FortiSwitch port feature settings from the FortiGate using the FortiSwitch CLI or Web
administration GUI.

FortiSwitch ports display
TheWiFi & Switch Controller > FortiSwitch Ports page displays port information about each of the
managed switches.

The following figure shows the display for a FortiSwitch 524D-FPOE:

The switch faceplate displays:

l active ports (green)
l PoE-enabled ports (blue rectangle)
l FortiLink port (link icon)

PoE Status displays the total power budget and the actual power currently allocated.

The allocated power displays a blue bar for the used power (currently being consumed) and a green bar for the
reserved power (power available for additional devices on the POE ports). See the following figures:

Each entry in the port list displays the following information:

l Port status (red for down, green for up)
l Port name
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l Native VLAN
l Allowed VLANs
l Device information
l PoE status
l Bytes sent and received by the port

Configuring ports using the GUI
You can use theWiFi & Switch Controller > FortiSwitch Ports page to do the following with FortiSwitch
switch ports:

l Set the native VLAN and add more VLANs
l Edit the description of the port
l Enable or disable the port
l Enable or disable PoE for the port
l Enable or disable DHCP blocking (if supported by the port)
l Enable or disable IGMP snooping (if supported by the port)
l Enable or disable whether a port is an edge port
l Enable or disable STP (if supported by the port)
l Enable or disable loop guard (if supported by the port)
l Enable or disable STP BPDU guard (if supported by the port)
l Enable or disable STP root guard (if supported by the port)

Resetting PoE-enabled ports

If you need to reset PoE-enabled ports, go toWiFi & Switch Control > FortiSwitch Ports, right-click on one
or more PoE-enabled ports and select Reset PoE from the context menu.

You can also go toWiFi & Switch Control > Managed FortiSwitch and click on a port icon for the FortiSwitch
of interest. In the FortiSwitch Ports page, right-click on one or more PoE-enabled ports and select Reset PoE
from the context menu.

Configuring ports using the FortiGate CLI
You can configure the following FortiSwitch port settings using the FortiGate CLI:

l Configuring port speed and status on page 2389
l Configure a VLAN on the port (see VLAN Configuration)
l Configuring the DHCP trust setting on page 2389
l Configuring PoE on page 2389
l Configuring edge ports on page 2390
l Configuring STP on page 2391
l Configuring STP root guard on page 2392
l Configuring STP BPDU guard on page 2393
l Configuring loop guard on page 2394
l Configuring LLDP settings on page 2395
l Configuring IGMP settings on page 2395
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Configuring port speed and status

Use the following commands to set port speed and other base port settings:

config switch-controller managed-switch
edit <switch>

config ports
edit <port>

set description <text>
set speed <speed>
set status {down | up}

end
end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1

set description "First port"
set speed auto
set status up

end
end

Configuring the DHCP trust setting

The DHCP blocking feature monitors the DHCP traffic from untrusted sources (for example, typically host ports
and unknown DHCP servers) that might initiate traffic attacks or other hostile actions. To prevent this, DHCP
blocking filters messages on untrusted ports.

Set the port as a trusted or untrusted DHCP-snooping interface:

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set dhcp-snooping {trusted | untrusted}
end

end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1

set dhcp-snooping trusted
end

end

Configuring PoE

The following PoE CLI commands are available starting in FortiSwitchOS 3.3.0.
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Enable PoE on the port

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set poe-status {enable | disable}
end

end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1

set poe-status enable
end

end

Reset the PoE port

Power over Ethernet (PoE) describes any system that passes electric power along with data on twisted pair
Ethernet cabling. Doing this allows a single cable to provide both data connection and electric power to devices
(for example, wireless access points, IP cameras, and VoIP phones).

The following command resets PoE on the port:

execute switch-controller poe-reset <fortiswitch-id> <port>

Display general PoE status

get switch-controller <fortiswitch-id> <port>

The following example displays the PoE status for port 6 on the specified switch:

# get switch-controller poe FS108D3W14000967 port6
Port(6) Power:3.90W, Power-Status: Delivering Power
Power-Up Mode: Normal Mode
Remote Power Device Type: IEEE802.3AT PD
Power Class: 4
Defined Max Power: 30.0W, Priority:3
Voltage: 54.00V
Current: 78mA

Configuring edge ports

Use the following commands to enable or disable an interface as an edge port:

config switch-controller managed-switch
edit <switch>

config ports
edit <port>

set edge-port {enable | disable}
end
end
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For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1

set edge-port enable
end

end

Configuring STP

Starting with FortiSwitch Release 3.4.2, STP is enabled by default for the non-FortiLink ports on the managed
FortiSwitches. STP is a link-management protocol that ensures a loop-free layer-2 network topology.

To configure global STP settings, see Configure STP settings on page 1.

Use the following commands to enable or disable STP on FortiSwitch ports:

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set stp-state {enabled | disabled}
end

end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1

set stp-state enabled
end

end

To check the STP configuration on a FortiSwitch, use the following command:

diagnose switch-controller dump stp <FortiSwitch_serial_number> <instance_number>

For example:

FG100D3G15817028 # diagnose switch-controller dump stp S524DF4K15000024 0

MST Instance Information, primary-Channel:

Instance ID : 0

Switch Priority : 24576

Root MAC Address : 085b0ef195e4
Root Priority: 24576
Root Pathcost: 0
Regional Root MAC Address : 085b0ef195e4
Regional Root Priority: 24576
Regional Root Path Cost: 0
Remaining Hops: 20
This Bridge MAC Address : 085b0ef195e4
This bridge is the root

Port Speed Cost Priority Role State Edge STP-Status Loop
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Protection
________________ ______ _________ _________ ___________ __________ ____ __________ ________

port1 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port2 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port3 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port4 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port5 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port6 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port7 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port8 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port9 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port10 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port11 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port12 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port13 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port14 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port15 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port16 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port17 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port18 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port19 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port20 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port21 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port22 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port23 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port25 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port26 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port27 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port28 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port29 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
port30 - 200000000 128 DISABLED DISCARDING YES ENABLED NO
internal 1G 20000 128 DESIGNATED FORWARDING YES DISABLED NO
__FoRtI1LiNk0__ 1G 20000 128 DESIGNATED FORWARDING YES DISABLED NO

Configuring STP root guard

Root guard protects the interface on which it is enabled from becoming the path to root. When enabled on an
interface, superior BPDUs received on that interface are ignored or dropped. Without using root guard, any switch
that participates in STPmaintains the ability to reroute the path to root. Rerouting might cause your network to
transmit large amounts of traffic across suboptimal links or allow a malicious or misconfigured device to pose a
security risk by passing core traffic through an insecure device for packet capture or inspection. By enabling root
guard on multiple interfaces, you can create a perimeter around your existing paths to root to enforce the
specified network topology.

Enable root guard on all ports that should not be root bridges. Do not enable root guard on the root port. You must
have STP enabled to be able to use root guard.

Use the following commands to enable or disable STP root guard on FortiSwitch ports:

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set stp-root-guard {enabled | disabled}
end

end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1
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set stp-root-guard enabled
end

end

Configuring STP BPDU guard

Similar to root guard, BPDU guard protects the designed network topology. When BPDU guard is enabled on STP
edge ports, any BPDUs received cause the ports to go down for a specified number of minutes. The BPDUs are
not forwarded, and the network edge is enforced.

There are two prerequisites for using BPDU guard:

l You must define the port as an edge port with the set edge-port enable command.
l You must enable STP on the switch interface with the set stp-state enabled command.

You can set how long the port will go down when a BPDU is received for a maximum of 120 minutes. The default
port timeout is 5 minutes. If you set the timeout value to 0, the port will not go down when a BPDU is received,
but you will have manually reset the port.

Use the following commands to enable or disable STP BPDU guard on FortiSwitch ports:

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set stp-bpdu-guard {enabled | disabled}
set stp-bpdu-guard-time <0-120>

end
end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1

set stp-bpdu-guard enabled
set stp-bpdu-guard-time 10

end
end

To check the configuration of STP BPDU guard on a FortiSwitch, use the following command:

diagnose switch-controller dump bpdu-guard-status <FortiSwitch_serial_number>

For example:

FG100D3G15817028 # diagnose switch-controller dump bpdu-guard-status
S524DF4K15000024
Managed Switch : S524DF4K15000024 0

Portname State Status Timeout(m) Count Last-Event
_________________ _______ _________ ___________ _____ _______________

port1 enabled - 10 0 -
port2 disabled - - - -
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port3 disabled - - - -
port4 disabled - - - -
port5 disabled - - - -
port6 disabled - - - -
port7 disabled - - - -
port8 disabled - - - -
port9 disabled - - - -
port10 disabled - - - -
port11 disabled - - - -
port12 disabled - - - -
port13 disabled - - - -
port14 disabled - - - -
port15 disabled - - - -
port16 disabled - - - -
port17 disabled - - - -
port18 disabled - - - -
port19 disabled - - - -
port20 disabled - - - -
port21 disabled - - - -
port22 disabled - - - -
port23 disabled - - - -
port25 disabled - - - -
port26 disabled - - - -
port27 disabled - - - -
port28 disabled - - - -
port29 disabled - - - -
port30 disabled - - - -
__FoRtI1LiNk0__ disabled - - - -

Configuring loop guard

A loop in a layer-2 network results in broadcast storms that have far-reaching and unwanted effects. Fortinet loop
guard helps to prevent loops. When loop guard is enabled on a switch port, the port monitors its subtending
network for any downstream loops. The loop guard feature is designed to work in concert with STP rather than as
a replacement for STP. By default, loop guard is disabled on all ports.

Use the following commands to configure loop guard on a FortiSwitch port:

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set loop-guard {enabled | disabled}
set loop-guard-timeout <0-120 minutes>

end
end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port1

set loop-guard enabled
set loop-guard-timeout 10

end
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end

Configuring LLDP settings

The Fortinet data center switches support the Link Layer Discovery Protocol (LLDP) for transmission and
reception wherein the switch will multicast LLDP packets to advertise its identity and capabilities. A switch
receives the equivalent information from adjacent layer-2 peers.

Use the following commands to configure LLDP on a FortiSwitch port:

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set lldp-status {rx-only | tx-only | tx-rx | disable}
set lldp-profile <profile name>

end
end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port2

set lldp-status tx-rx
set lldp-profile default

end
end

Configuring IGMP settings

IGMP snooping allows the FortiSwitch to passively listen to the Internet Group Management Protocol (IGMP)
network traffic between hosts and routers. The switch uses this information to determine which ports are
interested in receiving each multicast feed. FortiSwitch can reduce unnecessary multicast traffic on the LAN by
pruning multicast traffic from links that do not contain a multicast listener.

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port name>

set igmp-snooping {enable | disable}
set igmps-flood-reports {enable | disable}

end
end

For example:

config switch-controller managed-switch
edit S524DF4K15000024

config ports
edit port3

set igmp-snooping enable
set igmps-flood-reports enable

end
end
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The features listed here are valuable in endpoint authorization and access-control within a retail/enterprise LAN
environment. In a FortiLink setup, you can configure these capabilities from the FortiGate while endpoints are
connected to switch ports.

NOTE: In FortiLink mode, you must manually create a firewall policy to allow RADIUS traffic for 802.1x
authentication from the FortiSwitch (for example, from the FortiLink interface) to the RADIUS server through the
FortiGate.

End devices fall into two supported categories: one that supports 8021.X client and one that does not.

Before the Managed Release 5.6.0, only the following configuration was supported per VLAN:

l 802.1X

With Managed Release 5.6.0, additional port security features are available:

l Move 802.1X control from VLAN to port
o Previously, only one VLAN could be assigned to one port.  With both tagged and untagged VLANs allowed

in 5.4.x, this is no longer suitable and will be migrated to the switch port.
o Automatic configuration migration is supported.

l Support for client-less devices using mac-auth-bypass (MAB)
o For devices that are incapable of supporting EAPoL/EAP, FortiSwitch will conduct the authentication on

behalf of the device. Amaximum of three concurrent MAB devices per port can exist.
l Multiple secured endpoints on single port

o Enforcement is per MAC address
l Dynamic VLAN assignment

o RADIUS-assigned VLANs
l Guest VLAN configuration

o With authentication timeout
l RADIUS configuration

o Set secret keys for primary and secondary servers.
l User configuration

o Use a RADIUS server to authenticate users.
l Additional timers and modes

o Re-authentication period
o Maximum re-authentication attempts
o Link down to un-authenticate

NOTE: In the following commands, "*" indicates the default setting.

Configure the 802.1X settings for a virtual domain
To configure the 802.1X security policy for a virtual domain, use the following commands:

config switch-controller 802-1X-settings
set reauth-period < int >
set max-reauth-attempt < int >
set link-down-auth < *set-unauth | no-action >

end
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Option Description

set link-down-auth If a link is down, this command determines the authentication state.
Choosing set-auth sets the interface to unauthenticated when a link is
down, and reauthentication is needed. Choosing no-auth means that
the interface does not need to be reauthenticated when a link is down.

set reauth-period
This command sets how often reauthentication is needed. The range is 1-
1440 minutes. The default is 60 minutes. Setting the value to 0 minutes
disables reauthenticaion.

set max-reauth-attempt This command sets the maximum number of reauthentication attempts.
The range is 1-15. the default is 3. Setting the value to 0 disables
reauthentication.

Override the virtual domain settings
You can override the virtual domain settings for the 802.1X security policy.

Using the FortiGate GUI

To override the 802.1X settings for a virtual domain:

1. Go toWiFi & Switch Controller > Managed FortiSwitch.
2. Click on a FortiSwitch faceplate and clickEdit.
3. In the Edit Managed FortiSwitch page, move theOverride 802-1X settings slider to the right.
4. In the Reauthentication Interval field, enter the number of minutes before reauthentication is required. The

maximum interval is 1,440 minutes. Setting the value to 0 minutes disables reauthentiction.
5. In the Max Reauthentication Attempts field, enter the maximum times that reauthentication is attempted. The

maximum number of attempts is 15. Setting the value to 0 disables reauthentication.
6. Select Deauthenticate orNone for the link down action. Selecting Deauthenticate sets the interface to

unauthenticated when a link is down, and reauthentication is needed. Selecting Nonemeans that the interface
does not need to be reauthenticated when a link is down.

7. ClickOK.

Using the FortiGate CLI

To override the 802.1X settings for a virtual domain, use the following commands:

config switch-controller managed-switch
edit < switch >

config 802-1X-settings
set local-override [ enable | *disable ]

set reauth-period < int >                  // visible if override enabled
set max-reauth-attempt < int >             // visible if override enabled
set link-down-auth < *set-unauth | no-action >   // visible if override enabled

end
next

end

For a description of the options, see Configure the 802.1X settings for a virtual domain.
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Define an 802.1X security policy
You can define multiple 802.1X security policies.

Using the FortiGate GUI

To create an 802.1X security policy:

1. Go toWiFi & Switch Controller > FortiSwitch Security Policies.
2. ClickCreate New.
3. Enter a name for the new FortiSwitch security policy.
4. For the security mode, select Port-based orMAC-based.
5. Click + to select which user groups will have access.
6. Enable or disable guest VLANs on this interface to allow restricted access for some users.
7. Enter the number of seconds for authentication delay for guest VLANs. The range is 60-900 seconds.
8. Enable or disable authentication fail VLAN on this interface to allow restricted access for users who fail to access

the guest VLAN.
9. Enable or disable MAC authentication bypass (MAB) on this interface.
10. Enable or disable EAP pass-through mode on this interface.
11. Enable or disable whether the session timeout for the RADIUS server will overwrite the local timeout.
12. ClickOK.

Using the FortiGate CLI

To create an 802.1X security policy, use the following commands:

config switch-controller security-policy 802-1X
edit "<policy.name>"

set security-mode {802.1X | 802.1X-mac-based)
set user-group <*group_name | Guest-group | SSO_Guest_Users>
set mac-auth-bypass [enable | *disable]
set eap-passthru [enable | disable]
set guest-vlan [enable | *disable]
set guest-vlan-id "guest-VLAN-name"
set guest-auth-delay <integer>
set auth-fail-vlan  [enable | *disable]
set auth-fail-vlan-id "auth-fail-VLAN-name"
set radius-timeout-overwrite [enable | *disable]
set policy-type 802.1X

end
end

Option Description

set security-mode You can restrict access with 802.1X port-based authentication or with
802.1XMAC-based authentication.

set user-group You can set a specific group name, Guest-group, or SSO_Guest_Users to
have access.
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Option Description

set mac-auth-bypass You can enable or disable MAB on this interface.

set eap-passthrough You can enable or disable EAP pass-through mode on this interface.

set guest-vlan You can enable or disable guest VLANs on this interface to allow
restricted access for some users.

set guest-vlan-id "guest-
VLAN-name" You can specify the name of the guest VLAN.

set guest-auth-delay You can set the authentication delay for guest VLANs on this interface.
The range is 60-900 seconds.

set auth-fail-vlan You can enable or disable authentication fail VLAN on this interface to
allow restricted access for users who fail to access the guest VLAN.

set auth-fail-vlan-id
"auth-fail-VLAN-name"

You can specify the name of the authentication fail VLAN

set radius-timeout-
overwrite

You can enable or disable whether the session timeout for the RADIUS
server will overwrite the local timeout.

set policy-type 802.1X You can set the policy type to the 802.1X security policy.

Apply an 802.1X security policy to a FortiSwitch port
You can apply a different 802.1X security policy to each FortiSwitch port.

Using the FortiGate GUI

To apply an 802.1X security policy to a managed FortiSwitch port:

1. Go toWiFi & Switch Controller > FortiSwitch Ports.
2. Click the + next to a FortiSwitch.
3. In the Security Policy column for a port, click + to select a security policy.
4. ClickOK to apply the security policy to that port.

Using the FortiGate CLI

To apply an 802.1X security policy to a managed FortiSwitch port, use the following commands:

config switch-controller managed-switch
edit <managed-switch>

config ports
edit <port>

set port-security-policy <802.1X-policy>
next

end
next

end
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Additional capabilities

This chapter covers the following topics:

l Execute custom FortiSwitch commands on page 2401
l Firmware upgrade management and compatible version information on page 2402
l FortiSwitch log export on page 2402
l FortiSwitch per-port device visibility on page 2403
l FortiGate CLI support for FortiSwitch features (on non-FortiLink ports) on page 2403

Execute custom FortiSwitch commands
From the FortiGate, you can execute FortiSwitch commands on the managed FortiSwitch.

This feature adds a simple scripting mechanism for users to execute generic commands on the switch.

NOTE: FortiOS 5.6.0 introduces additional capabilities related to the managed FortiSwitch.

Create a command

Use the following syntax to create a command file:

config switch-controller custom-command
edit <cmd-name>

set command " <FortiSwitch commands>"

Next, create a command file to set the STP max-age parameter:

config switch-controller custom-command
edit "stp-age-10"

set command "config switch stp setting
set max-age 10
end

"
next

end

Execute a command

After you have created a command file, use the following command on the FortiGate to execute the command
file on the target switch:

exec switch-controller custom-command <cmd-name> <target-switch>

The following example runs the stp-age-10 command on the specified target FortiSwitch:

# exec switch-controller custom-command stp-age-10 S124DP3X15000118
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Firmware upgrade management and compatible version information
You can view the current firmware version of a FortiSwitch and upgrade the FortiSwitch to a new firmware
version. FortiGate will suggest an upgrade when a new version is available in FortiGuard.

Using the FortiGate Web interface

To view the FortiSwitch firmware version:

1. Go toWiFi & Switch Controller>Managed FortiSwitch.
2. In the main panel, select the FortiSwitch and clickEdit.
3. In the Edit Managed FortiSwitch panel, the Firmware section displays the current build on the FortiSwitch.

To update the FortiSwitch firmware version:

1. ClickUpdate to open the Update Firmware panel.
2. ClickSelect File. In the file chooser, click the image file and clickOpen.
3. ClickUpload and Reboot to install the new image and reboot the FortiSwitch.

Using the CLI

Use the following command to display the latest version:

diagnose fdsm fortisw-latest-ver <model>

Use the following command to download the image:

diagnose fdsm fortisw-download <image id>

The following example shows how to download the latest image for FS224D:

FG100D3G15801204 (global) # diagnose fdsm fortisw-latest-ver FS224D
FS224D - 3.4.2 b192 03004000FIMG0900904002FG100D3G15801204 (global) #

diagnose fdsm fortisw-download 03004000FIMG0900904002

Download image-03004000FIMG0900904002:
################################################################################
Result=Success

FortiSwitch log export
You can enable and disable the managed FortiSwitches to export their syslogs to the FortiGate. The setting is
global, and the default setting is enabled. Starting in FortiOS 5.6.3, more details are included in the exported
FortiSwitch logs.

To allow a level of filtering, FortiGate sets the user field to "fortiswitch-syslog” for each entry.

The following is the CLI command syntax:

config switch-controller switch-log
set status (*enable | disable)
set severity [emergency | alert | critical | error | warning | notification |

*information | debug]
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end

You can override the global log settings for a FortiSwitch, using the following commands:

config switch-controller managed-switch
edit <switch-id>

config switch-log
set local-override enable

At this point, you can configure the log settings that apply to this specific switch.

FortiSwitch per-port device visibility
In the FortiGate GUI, User & Device >Device List displays a list of devices attached to the FortiSwitch ports.
For each device, the table displays the IP address of the device and the interface (FortiSwitch name and port).

From the CLI, the following command displays information about the host devices:

diagnose switch-controller dump mac-hosts_switch-ports

FortiGate CLI support for FortiSwitch features (on non-FortiLink ports)
You can configure the following FortiSwitch features from the FortiGate CLI.

Configuring a link aggregation group (LAG)

You can configure a link aggregation group (LAG) for non-FortiLink ports on a FortiSwitch. You cannot configure
ports from different FortiSwitches in one LAG.

config switch-controller managed-switch
edit <switch-id>

config ports
it <trunk name>

set type trunk
set mode < static | lacp > Link Aggregation mode
set bundle (enable | disable)
set min-bundle <int>
set max-bundle <int>
set members < port1 port2 ...>

next
end

end
end

Configuring an MCLAG with managed FortiSwitches

Amultichassis LAG (MCLAG) provides node-level redundancy by grouping two FortiSwitch models together so
that they appear as a single switch on the network. If either switch fails, the MCLAG continues to function without
any interruption, increasing network resiliency and eliminating the delays associated with the Spanning Tree
Protocol (STP). For the network topology, see Dual-homed servers connected to FortiLink tier-1 FortiSwitches
using an MCLAG and Standalone FortiGate with dual-homed FortiSwitch access .
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Notes

l Both peer switches should be of the same hardware model and same software version. Mismatched configurations
might work but are unsupported.

l There is a maximum of two FortiSwitch models per MCLAG.
l The routing feature is not available within an MCLAG.
l For static MAC addresses within an MCLAG, if one FortiSwitch learns the MAC address, the second FortiSwitch will

automatically learn the MAC address.

To configure an MCLAG with managed FortiSwitches:

1. For each MCLAG peer switch, log into the FortiSwitch to create a LAG:

config switch trunk
edit "LAG-member"

set mode lacp-active
set mclag-icl enable
set members "<port>" "<port>"

next

2. Enable the MCLAG on each managed FortiSwitch:

config switch-controller managed-switch
edit "<switch-id>"

config ports
edit "<trunk name>"

set type trunk
set mode {static | lacp-passive | lacp-active}
set bundle {enable | disable}
set members "<port>,<port>"
set mclag {enable | disable}

next
end

next

3. Log into each managed FortiSwitch to check the MCLAG configuration:

diagnose switch mclag

After the FortiSwitches are configured as MCLAG peer switches, any port that supports advanced features on the
FortiSwitch can become a LAG port. When mclag is enabled and the LAG port names match, an MCLAG peer
set is automatically formed. The member ports for each FortiSwitch in the MCLAG do not need to be identical to
the member ports on the peer FortiSwitch.

Configuring storm control

Storm control uses the data rate (packets/sec, default 500) of the link to measure traffic activity, preventing traffic
on a LAN from being disrupted by a broadcast, multicast, or unicast storm on a port.

When the data rate exceeds the configured threshold, storm control drops excess traffic. You can configure the
types of traffic to drop: broadcast, unknown unicast, or multicast.
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The storm control settings are global to all of the non-FortiLink ports on the managed switches. Use the following
CLI commands to configure storm control:

config switch-controller storm-control
set rate <rate>
set unknown-unicast (enable | disable)
set unknown-multicast (enable | disable)
set broadcast (enable | disable)

end

You can override the global storm control settings for a FortiSwitch using the following commands:

config switch-controller managed-switch
edit <switch-id>

config storm-control
set local-override enable

At this point, you can configure the storm control settings that apply to this specific switch.

Displaying port statistics

Port statistics will be accessed using the following FortiSwitch CLI command:

FG100D3G15804763 # diagnose switch-controller dump port-stats
S124DP3X16000413 port8
S124DP3X16000413 0 :
{

"port8":{
"tx-bytes":823526672,
"tx-packets":1402390,
"tx-ucast":49047,
"tx-mcast":804545,
"tx-bcast":548798,
"tx-errors":0,
"tx-drops":3,
"tx-oversize":0,
"rx-bytes":13941793,
"rx-packets":160303,
"rx-ucast":148652,
"rx-mcast":7509,
"rx-bcast":4142,
"rx-errors":0,
"rx-drops":720,
"rx-oversize":0,
"undersize":0,
"fragments":0,
"jabbers":0,
"collisions":0,
"crc-alignments":0,
"l3packets":0

}
}

Configuring QoS with managed FortiSwitches

Quality of Service (QoS) provides the ability to set particular priorities for different applications, users, or data
flows.
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NOTE: FortiGate does not support QoS for hard or soft switch ports.

FortiSwitch supports the following QoS configuration capabilities:

l Mapping the IEEE 802.1p and Layer 3 QoS values (Differentiated Services and IP Precedence) to an outbound QoS
queue number.

l Providing eight egress queues on each port.
l Policing the maximum data rate of egress traffic on the interface.

To configure the QoS for managed FortiSwitches:

1. Configure a Dot1p map.

A Dot1p map defines a mapping between IEEE 802.1p class of service (CoS) values (from incoming packets on a
trusted interface) and the egress queue values. Values that are not explicitly included in the map will follow the
default mapping, which maps each priority (0-7) to queue 0. If an incoming packet contains no CoS value, the
switch assigns a CoS value of zero.

NOTE:Do not enable trust for both Dot1p and DSCP at the same time on the same interface. If you do want to
trust both Dot1p and IP-DSCP, the FortiSwitch uses the latter value (DSCP) to determine the queue. The switch
will use the Dot1p value and mapping only if the packet contains no DSCP value.

config switch-controller qos dot1p-map
edit <Dot1p map name>

set description <text>
set priority-0 <queue number>
set priority-1 <queue number>
set priority-2 <queue number>
set priority-3 <queue number>
set priority-4 <queue number>
set priority-5 <queue number>
set priority-6 <queue number>
set priority-7 <queue number>

next
end

2. Configure a DSCPmap.

A DSCPmap defines a mapping between IP precedence or DSCP values and the egress queue values. For IP
precedence, you have the following choices:

o network-control—Network control
o internetwork-control—Internetwork control
o critic-ecp—Critic and emergency call processing (ECP)
o flashoverride—Flash override
o flash—Flash
o immediate—Immediate
o priority—Priority
o routine—Routine

config switch-controller qos ip-dscp-map
edit <DSCP map name>

set description <text>
configure map <map_name>

2406 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Additional capabilities

edit <entry name>
set cos-queue <COS queue number>
set diffserv {CS0 | CS1 | AF11 | AF12 | AF13 | CS2 | AF21 | AF22 | AF23

| CS3 | AF31 | AF32 | AF33 | CS4 | AF41 | AF42 | AF43 | CS5 | EF |
CS6 | CS7}

set ip-precedence {network-control | internetwork-control | critic-ecp
| flashoverride | flash | immediate | priority | routine}

set value <DSCP raw value>
next

end
end

3. Configure the egress QoS policy.

In a QoS policy, you set the scheduling mode for the policy and configure one or more CoS queues. Each egress
port supports eight queues, and three scheduling modes are available:

o With strict scheduling, the queues are served in descending order (of queue number), so higher number
queues receive higher priority.

o In simple round-robin mode, the scheduler visits each backlogged queue, servicing a single packet from
each queue before moving on to the next one.

o In weighted round-robin mode, each of the eight egress queues is assigned a weight value ranging from 0
to 63.

config switch-controller qos queue-policy
edit <QoS egress policy name>

set schedule {strict | round-robin | weighted}
config cos-queue
edit [queue-<number>]

set description <text>
set min-rate <rate in kbps>
set max-rate <rate in kbps>
set drop-policy {taildrop | random-early-detection}
set weight <weight value>
next

end
next

end

4. Configure the overall policy that will be applied to the switch ports.

config switch-controller qos qos-policy
edit <QoS egress policy name>

set default-cos <default CoS value 0-7>
set trust-dot1p-map <Dot1p map name>
set trust-ip-dscp-map <DSCP map name>
set queue-policy <queue policy name>

next
end

5. Configure each switch port.

config switch-controller managed-switch
edit <switch-id>

config ports
edit <port>
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set qos-policy <CoS policy>
next

end
next

end
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Troubleshooting

Troubleshooting FortiLink issues
If the FortiGate does not establish the FortiLink connection with the FortiSwitch, perform the following
troubleshooting checks.

Check the FortiGate configuration

To use the FortiGate GUI to check the FortiLink interface configuration:

1. In Network > Interfaces, double-click the interface used for FortiLink.
2. Ensure that Dedicated to FortiSwitch is set for this interface.

To use the FortiGate CLI to verify that you have configured the DHCP and NTP settings correctly:

1. Verify that the NTP server is enabled and that the FortiLink interface has been added to the list:

show system ntp

2. Ensure that the DHCP server on the Fortilink interface is configured correctly:

show system dhcp

Check the FortiSwitch configuration

To use FortiSwitch CLI commands to check the FortiSwitch configuration:

1. Verify that the switch system time matches the time on the FortiGate:

get system status

2. Verify that FortiGate has sent an IP address to the FortiSwitch (anticipate an IP address in the range 169.254.x.x):

get system interfaces

3. Verify that you can ping the FortiGate IP address:

exec ping x.x.x.x

To use FortiGate CLI commands to check the FortiSwitch configuration:

1. Verify that the connections from the FortiGate to the FortiSwitches are up:

exec switch-controller get-conn-status
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2. Verify that ports for a specific FortiSwitch stack are connected to the correct locations:

exec switch-controller get-physical-conn <FortiSwitch-Stack-ID>

3. Verify that all the ports for a specific FortiSwitch are up:

exec switch-controller get-conn-status <FortiSwitch-device-ID>
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Chapter 21 - Networking

Networking

This guide explains how to configure your network. It contains the following sections:

Chapter title Description

Interfaces l Explains the concepts of options for setting up interfaces and groupings of
sub-networks that can scale to a company’s growing requirements

DNS
l How to set DNS requirements for your network
l How to set FortiGate as a local DNS server

Advanced static routing l Explains universal and static routing concepts, equal cost multipath (ECMP)
and load balancing, policy routing, and routing in transparent mode

Dynamic routing overview
l Provides an overview of dynamic routing, compares static and dynamic
routing, and helps you decide which dynamic routing protocol is best for you

RIP l Describes a distance-vector routing protocol intended for small, relatively
homogeneous networks

OSPF
l Provides background on the specific protocol explaining terms used and how
the protocol works, as well as providing some troubleshooting information
and examples on configuring the protocols in different situations

BGP l Classless inter-domain routing
l Aggregate routes
l BGP is the only routing protocol to use TCP for a transport protocol

IS-IS
l Describes the link state protocol, is well-suited to smaller networks and with
near universal support on routing hardware. The section also provides
troubleshooting information and configuration examples

Multicast forwarding l Concepts and use of multicasting with the FortiGate

Troubleshooting
l Describes features, such as packet capture, that are useful for
troubleshooting purposes

What's new in Networking

This section contains a list of new features and enhancements for Networking.
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FortiOS version 5.6.4
There are no new features for Networking in FortiOS version 5.6.4.

FortiOS version 5.6.3
FortiOS version 5.6.3 includes the following new features and enhancements for Networking.

VXLAN loopback binding support

A Virtual Extensible LAN (VXLAN) unicast device can bind to a loopback interface as its underlying interface.

For more information, see VXLAN loopback binding on page 2433.

New option to configure DHCP renew time

You can now set a minimum DHCP renew time.

For more information, see Configuring the DHCP renew time on page 2424.

Fixed inability to delete multicast interfaces in the GUI

An issue where you could not delete interfaces in the GUI underNetwork > Multicast > Multicast Routing has
been fixed.

New CLI commands for showing and adding IPv6 addresses

In previous releases, you could only view client IPv6 DHCP addresses in the CLI by using diagnose ipv6
address list. This release introduces the ability to also view these addresses by entering get in the
interface (under config system interface).

Similarly, in previous releases, you could only view static IPv6 addresses under diagnose ipv6 address
list and by entering get under the interface. This release introduces the ability to also view them by entering
fnsysctl/sysctl ifconfig interface_id.

Static route GUI updates

The GUI pages for creating or editing static routes (underNetwork > Static Routes) have been updated.

When you create or edit a static route, you must specify the gateway first and then select the device interface.
The FortiGate GUI will try to populate the Interface field based on the value in theGateway field. If you specify a
gateway that is not in the same subnet as the selected interface, a warning message will appear.

Also, the Device field has been renamed to the Interface field.

DHCP relay agent option configuration

FortiGate now supports the ability to enable or disable the DHCP relay agent option.

For more information, see Configuring the DHCP relay agent option on page 2422.

FortiOS version 5.6.2
There are no new features for Networking in FortiOS version 5.6.2.
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FortiOS version 5.6.1
FortiOS version 5.6.1 includes the following new features and enhancements for Networking.

Recursive DNS server option

FortiGate now supports the following RFC 6106 IPv6 Router Advertisement options:

l Sending DNS search list option to downstream clients with Router Advertisements that use a static prefix
l Sending Recursive DNS server option to downstream clients with Router Advertisements that use a static prefix

For more information, see Configuring IPv6 Router Advertisement options for DNS configuration on page 2470.

Routing Monitor support for policy routes

You can now monitor policy routes using the FortiGate GUI. The Routing Monitor page now includes a Policy
option that lists the active policy routes on the FortiGate and provides information about them.

For more information, see Viewing the routing table on page 2475.

Control how routing changes affect active sessions

You can now control how active sessions are affected when dynamic routing changes occur that affect the routes
the active sessions are using. You can configure whether FortiGate maintains the original routing for the sessions
that are using the affected routes, or applies the routing table changes to the active sessions.

For more information, see Controlling how routing changes affect active sessions on page 2517.

FortiOS version 5.6
FortiOS version 5.6 includes the following new features and enhancements for Networking.

New command to view transceiver information

You can now use a command to display information about transceivers installed in FortiGate SFP/SFP+
interfaces. You can use this command on most FortiGate models that have SFP/SFP+ interfaces.

For more information, see Displaying information about the status of transceivers on page 2436.

BGP local-AS support

FortiGate now supports BGP local-AS.

For more information, see BGP local-AS support on page 2611.

Interface setting removed from SNMP community configuration page

The Interface column has been removed from the New SNMP Community configuration page (System
> SNMP > SNMP v1/v2c > Create New) in the FortiGate GUI.

Remove RPF checks from the state evaluation process

You can now remove RPF (reverse path forwarding) state checks without needing to enable asymmetric routing,
using the new set src-check disable CLI command.

For more information, see Removing RPF checks from the state evaluation process on page 2486.
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BGP enhancements

FortiGate now supports the following BGP enhancements:

l Option to stop BGP graceful restart process on timer only
l Option to bring down BGP neighbor upon link down
l Option to keep routes for a period after the BGP neighbor is down

For more information, see Configuring BGP graceful restart process on timer on page 2610,Configuring option to
bring down BGP neighbor when the link is down on page 2611, and Configuring option to keep routes for a period
after the BGP neighbor is down on page 2611.

FQDN support for static routes

You can now configure FQDN firewall addresses as destination addresses in a static route.

For more information, see Configuring FQDNs as a destination address in static routes on page 2474.

Priority for blackhole routes

You can now add a priority to a blackhole route to change its position relative to kernel routes in the routing table.

For more information, see Adding a blackhole route with a priority on page 2484.

DDNS refresh interval

You can now configure FortiGate to refresh DDNS IP addresses by periodically checking the configured DDNS
server.

For more information, see Configuring FortiGate to refresh DDNS IP addresses on page 2467.

GUI support for configuring IPv6 blackhole routes

You can now configure IPv6 blackhole routes in the FortiGate GUI.

For more information, see Configuring IPv6 blackhole routes on page 2483.

Support for SSL VPN and WAN link load balancing

You can now set virtual WAN link interfaces as destination interfaces in firewall policies for WAN link load
balancing, when SSL VPN is the source interface.

For more information, see SSL VPN and WAN link load balancing on page 2443.

DDNS support for No-IP

FortiGate now supports No-IP as a DDNS server.

IPv6 Router Advertisement options for DNS configuration

FortiGate now supports the following RFC 6106 IPv6 Router Advertisement options:

l Obtaining DNS search list options from upstream DHCPv6 servers
l Sending the DNS search list through Router Advertisement
l Sending the DNS search list through the FortiGate DHCP server

For more information, see Configuring IPv6 Router Advertisement options for DNS configuration on page 2470.
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SD-WAN replaces WAN LLB in FortiGate GUI

The term SD-WAN has replaced the term WAN LLB throughout the FortiGate GUI.
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Interfaces

Interfaces, both physical and virtual, allow traffic to flow between internal networks and the Internet, and between
internal networks. FortiGate has a number of options for setting up interfaces and groupings of subnetworks that
can scale to your organization’s growing requirements.

Administrative access
To help prevent FortiGate interfaces, especially the public-facing ports, from being accessed by users who you do
not want accessing them, you can configure protocols that an administrator must use to access FortiGate,
including:

l HTTPS
l PING
l FortiManager Access (FMG-Access)
l CAPWAP
l SSH
l SNMP
l FTM
l RADIUS Accounting
l FortiTelemetry

As a best practice, you should configure administrative access when you are setting the IP address for the port.

The following example adds an IPv4 address 172.20.120.100 to the WAN1 interface, and administrative access
to HTTPS and SSH.

Add an IP address to the WAN1 interface - web-based manager

1. Go to Network > Interface.
2. Select the WAN1 interface row and select Edit.
3. Select the Addressing Mode of Manual.
4. Enter the IP address for the port of 172.20.120.100/24.
5. ForAdministrative Access, select HTTPS and SSH.
6. Select OK.

Add an IP address to the WAN1 interface - CLI

config system interface
edit wan1

set ip 172.20.120.100/24
set allowaccess https ssh

end
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When you add or remove a protocol, you must type the entire list of protocols again.
For example, if you have an access list of HTTPS and SSH and you want to add PING,
you must use the following CLI command:

set allowaccess https ssh ping

If you use set allowsaccess ping, only ping is set and HTTPS and SSH are
removed.

Aggregate interfaces
Link aggregation (IEEE 802.3ad) allows you to bind two or more physical interfaces together to form an
aggregated link. This new link has the bandwidth of all the links combined. If a link in the group fails, traffic is
automatically transferred to the remaining interfaces with the only noticeable effect being reduced bandwidth.

This is similar to redundant interfaces, with the major difference being that a redundant interface group uses only
one link at a time, while an aggregate link group uses the total bandwidth of the functioning links in the group, up
to eight (or more).

Some FortiGate models support the IEEE standard 802.3ad for link aggregation.

An interface can be an aggregate interface if it meets the following criteria:

l It is a physical interface, not a VLAN interface or subinterface.
l It is not already part of an aggregate or redundant interface.
l It is in the same VDOM as the aggregated interface. Aggregate ports cannot span multiple VDOMs.
l It does not have an IP address and is not configured for DHCP or PPPoE.
l It is not referenced in any security policy, VIP, IP pool, or multicast policy.
l It is not an HA heartbeat interface.
l It is not one of the backplane interfaces of the FortiGate 5000 series.

Some FortiGate models do not support aggregate interfaces. In this case, the aggregate option is not available in
the FortiGate GUI or CLI. Also, you cannot create aggregate interfaces from interfaces in a switch port.

To see if a port is being used or has other dependencies, use the following CLI command:

diagnose sys checkused system.interface.name <interface_name>

When an interface is included in an aggregate interface, it is not listed in the Network > Interface page in the
FortiGate GUI. Interfaces still appear in the CLI, but if you configure those interfaces, it will not take effect. You
cannot configure the interface individually and it is not available to include in security policies, VIPs, IP pools, or
routing.

To avoid unintentional network issues when you configure Link Aggregation Control Protocol (LACP), disconnect
the interfaces that you want to add to the aggregate interface. After you finish configuring LACP, reconnect the
interfaces.

The following example creates an aggregate interface on a FortiGate 3810A, using ports 4 to 6, with an internal
IP address of 10.13.101.100, and administrative access to HTTPS and SSH.

2417 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Interfaces

Create an aggregate interface - web-based manager

1. Go to Network > Interface and select Create New, then Interface.
2. Enter the Name as Aggregate.
3. For the Type, select 802.3ad Aggregate.

If this option does not appear, your FortiGate unit does not support aggregate interfaces.

4. In the Physical Interface Members, click to add interfaces. Select port 4, 5, and 6.
5. Select the Addressing Mode of Manual.
6. Enter the IP address for the port of 10.13.101.100/24.
7. ForAdministrative Access, select HTTPS and SSH.
8. Select OK.

Create aggregate interface - CLI

config system interface
edit Aggregate

set type aggregate
set member port4 port5 port6
set vdom root
set ip 172.20.120.100/24
set allowaccess https ssh

end

Sending GARP on aggregate MAC changes

FortiGate sends out GARP (Gratuitous Address Resolution Protocol) announcements if the MAC address of a link
aggregated interface changes to a new IP pool address due to a link failure or change in ports. This is needed
when you use networking devices, such as some switches that do not perform this function when they receive
LACP (Link Aggregation Control Protocol) information about changes in the MAC information.

DHCP addressing mode on an interface
If you configure an interface to use DHCP, FortiGate automatically broadcasts a DHCP request from the
interface. The interface is configured with the IP address, any DNS server addresses, and the default gateway
address that the DHCP server provides.

DHCP IPv6 is similar to DHCP IPv4, except:

• No default gateway option is defined because a host learns the gateway using router
advertisement messages.
• There are no WINS servers because it is obsolete.

For more information about DHCP IPv6, see RFC 3315.

You can configure DHCP for an interface in Network > Interfaces in the FortiGate GUI. Select the interface
from the list, and select DHCP in the Addressing mode. The following table describes the DHCP status
information when DHCP is configured for an interface.
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Field Description

Status Displays DHCP status messages as the interface connects to the DHCP
server and gets addressing information. Select Status to refresh the
addressing mode status message.

Status can be one of the following values:

•   initializing: no activity
•   connecting:interface attempts to connect to the DHCP server
•   connected:interface retrieves an IP address, netmask, and other settings
from the DHCP server
•   failed:interface was unable to retrieve an IP address and other settings
from the DHCP server

Obtained IP/Netmask The IP address and netmask leased from the DHCP server. This is only
displayed if the Status is connected.

Renew Select this to renew the DHCP license for this interface. This is only
displayed if the Status is connected.

Expiry Date

The time and date when the leased IP address and netmask is no longer
valid for the interface. The IP address is returned to the pool to be allocated
to the next user request for an IP address. This is only displayed if the
Status is connected.

Default Gateway The IP address of the gateway defined by the DHCP server. This is
displayed only if the Status is connected, and if Receive default gateway
from server is selected.

Distance Enter the administrative distance for the default gateway retrieved from the
DHCP server. The administrative distance is an integer from 1 to 255, and
specifies the relative priority of a route when there are multiple routes to the
same destination. A lower administrative distance indicates a more
preferred route.

Retrieve default gateway
from server

Enable this to retrieve a default gateway IP address from the DHCP server.
The default gateway is added to the static routing table.

Override internal DNS Enable this to use the DNS addresses retrieved from the DHCP server
instead of the DNS server IP addresses on the DNS page.

When VDOMs are enabled, you can override the internal DNS only on the
management VDOM.

DHCP servers and relays
ADHCP server provides an address, from a defined address range, to a client on the network that requests it.
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An interface cannot provide both a server and a relay for connections of the same type (regular or IPsec).
However, you can configure a regular DHCP server on an interface only if the interface is a physical interface with
a static IP address. You can configure an IPsec DHCP server on an interface that has either a static or a dynamic
IP address.

You can configure one or more DHCP servers on any FortiGate interface. A DHCP server dynamically assigns IP
addresses to hosts on the network connected to the interface. The host computers must be configured to obtain
their IP addresses using DHCP.

If an interface is connected to multiple networks through routers, you can add a DHCP server for each network.
The IP range of each DHCP server must match the network address range. The routers must be configured for
DHCP relay.

You can configure a FortiGate interface as a DHCP relay. The interface forwards DHCP requests from DHCP
clients to an external DHCP server and returns the responses to the DHCP clients. The DHCP server must have
appropriate routing so that its response packets to the DHCP clients arrive at the unit.

DHCP server options are not available in transparent mode.

Configuring DHCP servers

To add a DHCP server, go to Network > Interfaces. Edit the interface, and select DHCP in the addressing
mode.

Field Description

Address Range By default, the FortiGate unit assigns an address range based on
the address of the interface for the complete scope of the
address.

For example, if the interface address is 172.20.120.230, the
default range created is 172.20.120.231 to 172.20.120.254.

Select the range and select Edit to adjust the range or select
Create New to add a different range.

Netmask Enter the netmask of the addresses that the DHCP server assigns.

Default Gateway Select this to use either Same as Interface IP or select Specify and enter
the IP address of the default gateway that the DHCP server assigns to
DHCP clients.

DNS Server Select this to use Same as system DNS, Same as Interface IP or select
Specify and enter the IP address of the DNS server.

Mode Select the type of DHCP server FortiGate will be. By default, it is a Server.
Select Relay if needed. When Relay is selected, the above configuration
is replaced by a field to enter the DHCP Server IP address.

DHCP Server IP This appears only whenMode isRelay. Enter the IP address of the DHCP
server where FortiGate obtains the requested IP address.
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Field Description

Type Select this to use the DHCP in Regular or IPsecmode.

Additional DHCP Options Use this to create new DHCP options.

MAC Address + Access
Control

Select this to match an IP address from the DHCP server to a specific client
or device using its MAC address.

In a typical situation, an IP address is assigned ad hoc to a client, and that
assignment times out after a specific time of inactivity from the client,
known as the lease time. To ensure a client or device always has the same
IP address (there is no lease time), use IP reservation.

Add from DHCP Client List If the client is currently connected and using an IP address from the DHCP
server, you can select this option to select the client from the list.
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Configuring the DHCP relay agent option

You can configure the DHCP relay agent option (option 82 in RFC 3046). You can enable or disable whether the
DHCP relay agent option is added. This option is disabled, by default.

To configure the DHCP relay agent option, use the following CLI commands:

config system interface
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edit <name>
set dhcp-relay-agent-option [enable | disable]

next
end

For more information about the DHCP relay option, see RFC 3046 (DHCPRelay Agent Information Option).

Configuring DHCP with IPv6

You can use DHCPwith IPv6, using the CLI. To configure DHCP, ensure IPv6 is enabled by going to System
> Feature Visibility and enable IPv6 underBasic Features. Use the following CLI command:

config system dhcp6 server

DHCPv6 prefix delegation

Prefix delegation is supported for DHCP for IPv6 addressing. It is not practical to manually provision networks on
a large scale in IPv6 networking. The DHCPv6 prefix delegation feature is used to assign a network address
prefix, and automate the configuration and provisioning of the public routable addresses for the network.

You can enable the prefix delegation, using the following CLI commands:

config system interface
edit "wan1"

config ipv6
set ip6-mode dhcp
set ip6-allowaccess ping
set dhcp6-prefix-delegation enable
end

end

DHCPv6 prefix hint

This feature is used to "hint" to upstream DCHPv6 servers a desired prefix length for their subnet to be assigned
in response to its request.

There is a possibility of duplicate prefixes being sent by ISP when using a /64 bit subnet because the first 64 bits
of the address are derived from the MAC address of the interface. This could cause an issue if the system
administrator wishes to divide the host networks into 2 /64 bit subnets.

By receiving a /60 bit (for example) network address, the administrator can then divide the internal host works
without the danger of creating duplicate subnets.

Also included in the new feature, are preferred times for the life and valid life of the DHCP lease.

DHCPv6 hint for the prefix length:

set dhcp6-prefix-hint <DHCPv6 prefix that will be used as a hint to the upstream DHCPv6 server>

DHCPv6 hint for the preferred life time:

set dhcp6-prefix-hint-plt <integer> 1 ~ 4294967295 seconds or "0" for unlimited lease time

DHCPv6 hint for the valid life time:

set dhcp6-prefix-hint-vlt <integer> 1 ~ 4294967295 seconds or "0" for unlimited lease time
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Service

On low-end FortiGate units, a DHCP server is configured on the internal interface, by default, with the following
values:

Field Value

Address Range 192.168.1.110 to 192.168.1.210

Netmask 255.255.255.0

Default Gateway 192.168.1.99

Lease Time 7 days

DNS Server 1 192.168.1.99

These settings are appropriate for the default internal interface IP address of 192.168.1.99. If you change this
address to a different network, you need to change the DHCP server settings to match.

Alternatively, after the FortiGate unit assigns an address, you can go toMonitor > DHCP Monitor and locate
the specific user. Right-click and select Create/Edit IP Reservation.

Configuring the lease time

The lease time determines the length of time an IP address remains assigned to a client. Once the lease expires,
the address is released for allocation to the next client that requests an IP address.

To configure the lease time, use the following CLI commands:

config system dhcp server
edit <server_entry_number>

set lease-time <seconds>
next

end

The default lease time is seven days. To have an unlimited lease time, set the value to zero.

Configuring the DHCP renew time

You can set a minimum DHCP renew time. This option is available only when mode is set to dhcp.

To set the DHCP renew time, using the following CLI commands:

config system interface
edit <name>

set mode dhcp
set dhcp-renew-time <seconds>

next
end

The possible values for dhcp-renew-time are 300 to 605800 seconds (five minutes to seven days). To use the
renew time that the server provides, set this entry to 0.
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DHCP options

When you add a DHCP server, you can include DHCP codes and options. The DHCP options are BOOTP vendor
information fields that provide additional vendor-independent configuration parameters to manage the DHCP
server. For example, you may need to configure a FortiGate DHCP server that gives out a separate option, as
well as an IP address, such as an environment that needs to support PXE boot with Windows images.

The option numbers and codes are specific to a particular application. The documentation for the application
should provide the values you should use. Option codes are represented in option value and HEX value pairs. The
option is a value between 1 and 255.

You can add up to three DHCP code/option pairs per DHCP server.

To configure option 252 with value http://192.168.1.1/wpad.dat (FortiGate CLI)

config system dhcp server
edit <server_entry_number>

set option1 252 687474703a2f2f3139322e3136382e312e312f777061642e646174
end

For more information about DHCP options, see RFC 2132 (DHCPOptions and BOOTP Vendor Extensions).

FortiGate DHCP works with DDNS to allow FQDN connectivity to leased IP addresses

As clients are assigned IP addresses, they send back information that would be found in an A record to the
FortiGate DHCP server, which can take this information and pass it back to a corporate DNS server so that even
devices using leased IP address can be reached using FQDNs. You can configure the settings for this feature
using the ddns-update CLI command and some other ddns related options.

DHCP server option fields

In place of specific fields, the DHCP server maintains a table for the potential options. The FortiOS DHCP server
supports up to a maximum of 30 custom options.These optional fields are set in the CLI.

To get to the DHCP server, use the following CLI commands:

config system dhcp server
edit <integer - ID of the specific DHCP server>

To configure the options, use the following CLI command:

config options

Once you are in the options context, create an ID for the table entry, using the following CLI commands:

edit <integer>
set code <integer between 0 - 4294967295 to determine the DHCP option>
set type [ hex | string | ip ]
set value <option content for DHCP option types hex and string>
set ip <option content for DHCP option type ip>

end

Excluding addresses in DHCP

If you have a large address range for the DHCP server, you can block a range of addresses that will not be
included in the available addresses for the connecting users.

To do this, use the following CLI commands:
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config system dhcp server
edit <server_entry_number>

config exclude-range
edit <sequence_number>

set start-ip <address>
set end-ip <address>

end
end

end

Viewing information about DHCP server connections

To view information about DHCP server connections, go toMonitor > DHCP Monitor. On this page, you can
also add IP addresses to the reserved IP address list.

Breaking an address lease

If you need to end an IP address lease, you can break the lease. This is useful if you have limited addresses and
longer lease times, when some leases are no longer necessary, for example, with corporate visitors.

To break a lease, use the following CLI command:

execute dhcp lease-clear <ip_address>

Interface MTU packet size
You can change the maximum transmission unit (MTU) of the packets that FortiGate transmits to improve
network performance. Ideally, the MTU should be the same as the smallest MTU of all the networks between
FortiGate and the destination of the packets. If the packets that the FortiGate unit sends are larger than the
smallest MTU, they are broken up or fragmented, which slows down transmission. You can easily experiment by
lowering the MTU to find an MTU size for optimum network performance.

l 68 to 1500 bytes for static mode
l 576 to 1500 bytes for DHCPmode
l 576 to 1492 bytes for PPPoEmode
l Larger frame sizes (if supported by the FortiGate model), up to 9216 bytes for NP2, NP4, and NP6-accelerated

interfaces

This option is available only for physical interfaces. Virtual interfaces associated with a physical interface inherit
the physical interface MTU size.

Interfaces on some FortiGate models support frames larger than the traditional 1500 bytes. Jumbo frames are
supported on FortiGate models that have either a SOC2 or NP4lite (except for the FortiGate 30D), and on
FortiGate 100D series models.

If you need to send larger frames over a route, all Ethernet devices on that route must support the larger frame
size. Otherwise, the larger frames will not be recognized and will be dropped.

If you have standard size and larger size frame traffic on the same interface, routing alone cannot route them to
different routes based only on frame size. However, you can use VLANs to make sure the larger frame traffic is
routed over network devices that support the larger size. VLANs inherit the MTU size from the parent interface.
You must configure the VLAN to include both ends of the route, as well as all switches and routers along the
route.
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You can configure the MTU packet size. If you select an MTU size larger than your FortiGate model supports, an
error message will indicate this. In this situation, try configuring a smaller MTU size until the value is supported.

In transparent mode, if you change the MTU of an interface, you must change the
MTU of all interfaces on FortiGate to match the new MTU.

To change the MTU size, use the following CLI commands:

config system interface
edit <interface_name>

set mtu-override enable
set mtu <byte_size>

end

Interface settings
You configure FortiGate interfaces, both physical and virtual, in Network > Interfaces in the FortiGate GUI.
There are different options for configuring interfaces when FortiGate is in NAT mode or transparent mode.

On FortiOS Carrier, you can also enable the Gi gatekeeper on each interface for anti-overbilling.

Field Description

Create New Select this to add a new interface, zone, or port pair (in transparent mode).

Depending on the FortiGate model, you can add a VLAN interface, a
loopback interface, an IEEE 802.3ad aggregated interface, or a redundant
interface.

When VDOMs are enabled, you can also add Inter-VDOM links.

Name

The names of the physical interfaces on FortiGate. This includes any alias
names that have been configured.

When you combine several interfaces into an aggregate or redundant
interface, only the aggregate or redundant interface is listed, and not the
component interfaces.

If you added VLAN interfaces, they appear in the name list below the
physical or aggregated interface to which they have been added.

If you added loopback interfaces, they appear in the interface list below
the physical interface to which they have been added. If software switch
interfaces are configured, you can view them.

If your FortiGate model supports AMCmodules, the interfaces are named
amc-sw1/1, amc-dw1/2, and so on.

Type The configuration type for the interface.
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Field Description

IP/Netmask

The current IP address and netmask of the interface.

In VDOM, when VDOMs are not all in NAT or transparent mode, some
values may not be available for display and are displayed as “-”.

Access The administrative access configuration for the interface.

Administrative Status

Indicates if the interface can be accessed for administrative purposes. If
the administrative status is a green arrow, an administrator can connect to
the interface using the configured access.

If the administrative status is a red arrow, the interface is administratively
down and cannot be accessed for administrative purposes.

Link Status The status of the interface physical connection. The link status can be up
(green arrow) or down (red arrow). If the link status is up, the interface is
connected to the network and accepting traffic. If the link status is down,
the interface is either not connected to the network or there is a problem
with the connection.

You cannot change the link status from the FortiGate GUI, and it typically
indicates that an Ethernet cable is plugged into the interface.

The link status is only displayed for physical interfaces.

MAC The MAC address of the interface.

Mode The addressing mode of the interface. This value can be manual, DHCP, or
PPPoE.

Secondary IP The secondary IP addresses added to the interface.

MTU The maximum number of bytes per transmission unit for the interface.

Virtual Domain The virtual domain to which the interface belongs. This column is visible
when VDOM configuration is enabled.

VLAN ID The configured VLAN ID for VLAN subinterfaces.

Interface configuration and settings

To configure an interface, go to Network > Interfaces, and select Create New.

Name Enter the name of the interface. Physical interface names cannot be
changed.
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Alias

Enter an alternate name for a physical interface on the FortiGate unit.
This field appears when you edit an existing physical interface.

The alias is a maximum of 25 characters. The alias name does not
appear in logs.

Link Status Indicates whether the interface is connected to a network (link status is
Up) or not (link status isDown). This field appears when you edit an
existing physical interface.

Type

Select the type of interface you want to add.

On some FortiGate models, you can set Type to 802.3ad Aggregate or
Redundant Interface.

Interface This is displayed when Type is set to VLAN.

Select the name of the physical interface that you want to add a VLAN
interface to. Once created, the VLAN interface is listed below its
physical interface in the Interface list.

You cannot change the physical interface of a VLAN interface except
when you add a new VLAN interface.

VLAN ID

This is displayed when Type is set to VLAN.

Enter the VLAN ID. You cannot change the VLAN ID except when you
add a new VLAN interface.

The VLAN ID must be a number between 1 and 4094. It must match the
VLAN ID that the IEEE 802.1Q-compliant router or switch that is
connected to the VLAN subinterface adds.

Virtual Domain Select the virtual domain to add the interface to.

Administrator accounts with the super_admin profile can change the
Virtual Domain.

Physical Interface Members

This section can have two different formats depending on the interface
type:

• Software switch interface: This section is a display-only field that
shows the interfaces that belong to the virtual interface of the software
switch.
• 802.3ad aggregate or Redundant interface: This section includes
the available interface list and the selected interface list.

Select interfaces from the Available Interfaces list and select the right
arrow to add an interface to the Selected Interface list.
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Addressing mode Select the addressing mode for the interface:

• Select Manual and add an IP/Netmask for the interface. If IPv6
configuration is enabled, you can add both a IPv4 and an IPv6 IP
address.
• Select DHCP to get the interface IP address and other network
settings from a DHCP server.
• Select PPPoE to get the interface IP address and other network
settings from a PPPoE server.
• Select One-Arm Sniffer to enable the interface as a means to detect
possible traffic threats. This option is available on physical ports that are
not configured for the primary Internet connection.
• Select Dedicate to FortiAP/FortiSwitch to have a FortiAP or
FortiSwitch device connect exclusively to the interface. This option is
available only when you edit a physical interface and it has a static IP
address. When you enter the IP address, FortiGate automatically
creates a DHCP server using the subnet that you enter. This option is
not available on the ADSL interface.

The FortiSwitch option is currently available only on the FortiGate 100D.

IP/Netmask
If Addressing Mode is set toManual, enter an IPv4 address and
subnet mask for the interface. FortiGate interfaces cannot have IP
addresses on the same subnet.

IPv6 Address If Addressing Mode is set toManual and IPv6 support is enabled,
enter an IPv6 address and subnet mask for the interface. A single
interface can have an IPv4 address, IPv6 address, or both.

Administrative Access Select the types of administrative access that you want to allow for IPv4
connections to this interface.

HTTPS Allow secure HTTPS connections to the FortiGate GUI through this
interface. If configured, this option will enable automatically when you
select the HTTP option.

PING The interface responds to pings. Use this setting to verify your
installation and for testing.

HTTP Allow HTTP connections to the FortiGate GUI through this interface. If
configured, this option will also enable the HTTPS option.

SSH Allow SSH connections to the CLI through this interface.

SNMP Allow a remote SNMPmanager to request SNMP information by
connecting to this interface.

FMG-Access
Allow FortiManager authorization automatically during the
communication exchanges between FortiManager and FortiGate
devices.
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CAPWAP Allows the FortiGate wireless controller to manage a wireless access
point, such as a FortiAP device.

IPv6 Administrative Access
Select the types of administrative access that you want to allow for IPv6
connections to this interface. The types are the same as for
Administrative Access.

Security Mode Select a captive portal for the interface. After you select this, you can
define the portal message and the appearance of the GUI that users see
when they log into the interface. You can also define one or more user
groups that can access the interface.

DHCP Server
Select this to enable a DHCP server for the interface. For more
information about configuring a DHCP server on the interface, see
DHCP servers and relays.

Device Detection Select this to allow the interface to be used with BYOD devices, such as
iPhones. Define the device definitions by selecting User & Device >
Device Inventory in the FortiGate GUI.

Enable Explicit Web Proxy

Select this to enable explicit web proxying on this interface.

This is available when you enable explicit proxy in the System
Information Dashboard (System >Dashboard >Status).

When you enable this, the interface will be displayed in System >
Network >Explicit Proxy, under Listen on Interfaces, and web
traffic on this interface will be proxied according to the Web Proxy
settings.

This option is not available for a VLAN interface selection.

Secondary IP Address Add additional IPv4 addresses to this interface. Select the expand arrow
to expand or hide the section.

Comments Enter a description (up to 63 characters) to describe the interface.

Gi Gatekeeper (FortiOS
Carrier only)

For FortiOS Carrier, enable this to enable the Gi firewall as part of the
anti-overbilling configuration. You must also configureGi Gatekeeper
Settings by selecting System >Admin >Settings in the FortiGate
GUI.
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If you assign an interface to be part of a virtual wire pairing, the "role" value is removed from the interface.

Loopback interfaces
A loopback interface is a logical interface that is always up (no physical link dependency) and the attached subnet
is always present in the routing table.

The IP address of the FortiGate loopback interface does not depend on one specific external port, and therefore
you can access it through several physical or VLAN interfaces. You can configure multiple loopback interfaces in
either non-VDOM mode or in each VDOM.

Loopback interfaces still require appropriate firewall policies to allow traffic to and from the interfaces.

A loopback interface can be used with:

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2432



Interfaces

l Management access
l BGP (TCP) peering
l PIM RP

Loopback interfaces are a good practice for OSPF. To make troubleshooting OSPF easier, you should set the
OSPF router ID the same as the loopback IP address, and remember the management IP addresses (ssh to
“router ID”).

You can enable dynamic routing protocols on loopback interfaces.

For black hole static routes, use the black hole route type instead of the loopback interface.

VXLAN loopback binding

A Virtual Extensible LAN (VXLAN) unicast device can bind to a loopback interface as its underlying interface. The
IP address of the loopback interface is taken as the source IP address for its outgoing VXLAN packets so the peer
knows where to reply. Among the parameters that are passed to the kernel, the ifindex of the loopback interface
is not passed down to the kernel, so the kernel can choose the outgoing physical interface. This way, VXLAN
traffic can be routed across multiple physical links and it provides resistance to a single point of failure.

You can configure VXLAN loopback binding, using the following CLI commands:

config system vxlan
edit <name>

set interface <interface>
set vni <VXLAN network ID>
set remote-ip <IP address>

next
end

One-armed sniffer
You can use a one-armed sniffer to configure a FortiGate physical interface as a one-arm intrusion detection
system (IDS). Traffic sent to the interface is examined for matches to the configured IPS sensor and application
control list. Matches are logged and then all received traffic is dropped. Sniffing reports only on attacks. It does
not deny or otherwise influence traffic.

You can use the one-arm sniffer to configure FortiGate to operate as an IDS appliance by sniffing network traffic
for attacks without actually processing the packets. To configure one-arm IDS, you enable sniffer mode on a
FortiGate interface and connect the interface to a hub, or to the SPAN port of a switch that is processing network
traffic.

To assign an interface as a sniffer interface, select Network > Interfaces, edit the interface and select One-
Arm Sniffer.

If the check box is not available, it means the interface is in use. Ensure that the interface is not selected in any
firewall policies, routes, virtual IPs, or other features in which a physical interface is specified.
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Field Description

Enable Filters Select this to include filters that define a more granular sniff of network
traffic. Select specific hosts, ports, VLANs, and protocols.

In all cases, enter a number or number range for the filtering type. For
protocol values, the standard protocols are:

• UDP - 17
• TCP - 6
• ICMP - 1

Include IPv6 Packets If your network is running both IPv4 and IPv6 addressing, select this to sniff
both addressing types. Otherwise, FortiGate will sniff only IPv4 traffic.

Include Non-IP Packets Select this for a more intense scan of content in the traffic.

Security Profiles IPS sensors and application control lists allow you to select specific sensors
and applications that you want to identify within the traffic.
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Ports preassigned as sniffer ports

Some FortiGate models have ports preconfigured as sniffer ports, by default. The models and ports
preconfigered in sniffer mode are as follows:

l FortiGate 300D
l Port4
l Port8

l FortiGate 500D
l Port5
l Port6
l Port13
l Port14
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Physical ports
FortiGate has several physical ports that you can connect Ethernet or optical cables to. Depending on the
FortiGate model, it can have between 4 and 40 physical ports. Some units have a grouping of ports labeled as
lan, that provide built-in switch functionality.

The port names, as labeled on FortiGate, appear in the FortiGate GUI in the Unit Operation widget on the
dashboard. They also appear when you configure the interfaces, in Network > Interfaces.

You can hover over the ports to see information about each port, such as the name of the port and the IP address.

For example, the following diagram shows the 22 interfaces of the FortiGate 100 D (Generation 2) as they appear
in the dashboard in the FortiGate GUI.

Two of the physical ports on the FortiGate 100D (Generation 2) are SFP ports. These
ports share the numbers 15 and 16 with RJ-45 ports. Because of this, when SFP port
15 is used, RJ-45 port 15 cannot be used, and vice versa. These ports also share the
same MAC address.

Configuring the FortiGate 100D ports

Normally, you can configure the internal interface as a single interface that is shared by all physical interface
connections (a switch). The switch mode feature has two states: switch mode and interface mode. Switch mode
is the default mode, with only one interface and one address for the entire internal switch. Interface mode allows
you to configure each of the physical interface connections of the internal switch separately. This allows you to
assign different subnets and netmasks to each of the internal physical interface connections.

The larger FortiGate models may also include Advanced Mezzanine Cards (AMC), which can provide additional
interfaces (Ethernet or optical, with throughput enhancements for more efficient handling of specialized traffic.
These interfaces appear in FortiOS as port amc/sw1, amc/sw2, and so on.

Displaying information about the status of transceivers

You can display information about the status of transceivers installed in FortiGate SFP/SFP+ interfaces, in the
FortiGate CLI.

The get system interface transceiver command lists all of the SFP/SFP+ interfaces on FortiGate. If
the interfaces include transceivers, the command output displays information about them, such as the vendor
name, part number, and serial number. It also includes details about transceiver operation, such as temperature,
voltage, and optical transmission power, which you can use to diagnose transmission problems.

The following example shows an output from using this command:

get system interface transceiver
...
Interface port14 - Transceiver is not detected.
Interface port15 - SFP/SFP+
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Vendor Name : FIBERXON INC.
Part No. : FTM-8012C-SLG
Serial No. : 101680071708917

Interface port16 - SFP/SFP+
Vendor Name : FINISAR CORP.
Part No. : FCLF-8521-3
Serial No. : PS62ENQ

Optical Optical Optical
SFP/SFP+ Temperature Voltage Tx Bias Tx Power Rx Power
Interface (Celsius) (Volts) (mA) (dBm) (dBm)
------------ ------------ ------------ ------------ ------------ ------------
port15 N/A N/A N/A N/A N/A
port16 N/A N/A N/A N/A N/A
++ : high alarm, + : high warning, - : low warning, -- : low alarm, ? : suspect.

You can use this command on most FortiGate models that have SFP/SFP+ interfaces.

Split port support

The 5001D 40 GB can be split into 4 10 GB ports.You can do this through a combination of hardware and
software configuration. You use a specific 40 GB connector to connect to the 40 GB port and typically, the other
end of the fibre optic cable connects to another 40 GB port. However, you can use a special cable that is a single
40 GB connector at one end and 4 10 GB connections at the other end. To use this setup, you also have to
configure the port to be a split port.

You can configure this, using the following CLI commands:

config system global
set port-split port1 port2
end

The ports will be checked to make sure that they are not in use or referenced by other policy configurations. If
they are in use, the command is aborted. Changing the port to be a split port requires a system reboot.

PPPoE  addressing mode on an interface
If you configure the interface to use PPPoE, the FortiGate unit automatically broadcasts a PPPoE request from
the interface.

The FortiGate units support many PPPoERFC features (RFC 2516) including unnumbered IPs, initial discovery
timeout and PPPoE Active Discovery Terminate (PADT).

PPPoE is only configurable in the web-based manager on desktop FortiGate units. 1U FortiGates and up must be
configured in the CLI using the commands:

config system interface
edit <port_name>

set mode pppoe
set username <ISP_username>
set password <ISP_password>
set idle-timeout <seconds>
set distance <integer>
set ipunnumbered <unumbered-IP>
set disc-retry-timeout <seconds>
set padt-retry-timeout <seconds>
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set lcp-echo-interval <seconds>
set dns-server-override {enable | disable}

end

Configure PPPoE on an interface in Network > Interfaces. The following table describes the PPPoE status
information when PPPoE is configured for an interface.

Field Description

Status Displays PPPoE status messages as the FortiGate unit connects to the
PPPoE server and gets addressing information. Select Status to refresh
the addressing mode status message.

The status is only displayed if you selected Edit.

Status can be any one of the following 4 messages.

Initializing No activity.

Connecting The interface is attempting to connect to the PPPoE server.

Connected

The interface retrieves an IP address, netmask, and other settings from
the PPPoE server.

When the status is connected, PPPoE connection information is
displayed.

Failed The interface was unable to retrieve an IP address and other information
from the PPPoE server.

Reconnect
Select to reconnect to the PPPoE server.

Only displayed if Status is connected.

User Name The user name for the PPPoE account.

Password The password for the PPPoE account.

Unnumbered IP Specify the IP address for the interface. If your ISP has assigned you a
block of IP addresses, use one of them. Otherwise, this IP address can
be the same as the IP address of another interface or can be any IP
address.

Initial Disc Timeout Enter Initial discovery timeout. Enter the time to wait before starting to
retry a PPPoE discovery.

Initial PADT timeout Enter Initial PPPoE Active Discovery Terminate (PADT) timeout, in
seconds. Use this timeout to shut down the PPPoE session if it is idle for
the specified number of seconds. PADT must be supported by your ISP.
Set the Initial PADT timeout to 0 to disable.
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Field Description

Distance

Enter the administrative distance for the default gateway retrieved from
the PPPoE server. The administrative distance, an integer from 1-255,
specifies the relative priority of a route when there are multiple routes to
the same destination. A lower administrative distance indicates a more
preferred route. The default distance for the default gateway is 1.

Retrieve default gateway from
server

Enable to retrieve a default gateway IP address from a PPPoE server.
The default gateway is added to the static routing table.

Override internal DNS

Enable to replace the DNS server IP addresses on the System DNS page
with the DNS addresses retrieved from the PPPoE server.

When VDOMs are enabled, you can override the internal DNS only on the
management VDOM.

Probing interfaces
Server probes can be used on interfaces. In order for this to occur, the probe response mode must first be
configured, then the probe response must be allowed administrative access on the interface. The probe response
mode can one of the following:

Mode Description

none Disable probe

http-probe HTTP probe

twamp Two-Way Active Measurement Protocol

Both steps must be done through the CLI.

Configuring the probe

config system probe-response
set mode http-probe

end

Allowing the probe response to have administrative access to the interface

config system interface
edit <port>

set allowaccess probe-response
end

Enhanced TWAMP Light functionality with server/controller functionality

TWAMP(Two-Way Active Measurement Protocol) Light is a simplified architecture within the TWAMP standard.
Its purpose is to measure the round trip IP performance between any two devices within a network that supports
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the protocol. FortiOS operates in more than just the role of responder/reflector.The server/controller functionality
has been added.

Redundant interfaces
On some models, you can combine two or more physical interfaces to provide link redundancy. This feature
allows you to connect to two or more switches to ensure connectivity if one physical interface, or the equipment
on that interface, fails.

In a redundant interface, traffic travels only over one interface at a time. This differs from an aggregated interface
where traffic travels over all interfaces for distribution of increased bandwidth. This difference means that
redundant interfaces can have more robust configurations with fewer possible points of failure. This is important
in a fully-meshed HA configuration.

An interface can be in a redundant interface if:

l It is a physical interface, not a VLAN interface
l It is not already part of an aggregated or redundant interface
l It is in the same VDOM as the redundant interface
l It has no defined IP address
l It is not configured for DHCP or PPPoE
l It has no DHCP server or relay configured on it
l It does not have any VLAN subinterfaces
l It is not referenced in any security policy, VIP, or multicast policy
l It is not monitored by HA
l It is not one of the FortiGate-5000 series backplane interfaces

When an interface is included in a redundant interface, it is not listed on the Network > Interfaces page. You
cannot configure the interface individually and it is not available for inclusion in security policies, VIPs, or routing.

Dual Internet connections
Dual internet connections, also referred to as dual WAN or redundant Internet connections, refers to using two
FortiGate interfaces to connect to the Internet. Dual Internet connections can be used in three ways:

l Redundant interfaces: if one interface goes down, the second interface automatically becomes the main Internet
connection

l Load sharing: to ensure better throughput
l Combination of redundancy and load sharing

Redundant interfaces

Redundant interfaces ensure that if your Internet access is no longer available through a certain port, the
FortiGate unit will use an alternate port to connect to the Internet.

Configuring redundant interfaces

In this scenario, two interfaces, WAN1 and WAN2, are connected to the Internet using two different ISPs. WAN1
is the primary connection. In the event of a failure of WAN1, WAN2 automatically becomes the connection to the
Internet. For this configuration to function correctly, you need to configure three settings:
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l Configure a link health monitor to determine when the primary interface (WAN1) is down and when the connection
returns

l Configure a default route for each interface
l Configure security policies to allow traffic through each interface to the internal network

Link health monitor

Adding a link health monitor is required for routing failover traffic. A link health monitor will confirm the
connectivity of the device’s interface.

To add a link health monitor

config system link-monitor
edit “Example1”

set srcint <Interface_sending_probe>
set server <ISP_IP_address>
set protocol <Ping or http>
set gateway-ip <the_gateway_IP_to_reach_the_server_if_required>
set failtime <failure_count>
set interval <seconds>
set update-cascade-interface enable
set update-static-route enable
set status enable

end

Routing

You need to configure a default route for each interface and indicate which route is preferred by specifying the
distance. The lower distance is declared active and placed higher in the routing table.

When you have dual WAN interfaces that are configured to provide failover, you might
not be able to connect to the backup WAN interface because the FortiGate unit may
not route traffic (even responses) out of the backup interface. The FortiGate unit
performs a reverse path lookup to prevent spoofed traffic. If an entry cannot be found
in the routing table that sends the return traffic out the same interface, the incoming
traffic is dropped.

To configure the routing of the two interfaces - web-based manager

1. Go to Network > Static Routes and select Create New.
2. Enter the following information and select OK.

Destination IP/Mask For an IPv4 route, enter a subnet of 0.0.0.0/0.0.0.0

For an IPv6 route, enter a subnet of ::/0

Gateway Enter the gateway address

Interface Select the primary connection. For example,WAN1.

Administrative Distance Leave as the default of 10.

3. Repeat these steps to set Interface toWAN2 and Administrative Distance to 20.
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To configure the IPv4 routing of the two interfaces - CLI

config router static
edit 0

set dst 0.0.0.0 0.0.0.0
set device WAN1
set gateway <gateway_address>
set distance 10

next
edit 0

set dst 0.0.0.0 0.0.0.0
set device WAN2
set gateway <gateway_address>
set distance 20

next
end

To configure the IPv6 routing of the two interfaces - CLI

config router static6
edit 0

set dst ::/0
set device WAN1
set gateway <gateway_address>
set distance 10

next
edit 0

set dst ::/0
set device WAN2
set gateway <gateway_address>
set distance 20

next
end

Security policies

When creating security policies, you need to configure duplicate policies to ensure that after traffic fails over
WAN1, regular traffic will be allowed to pass through WAN2 as it did with WAN1. This ensures that failover will
occur with minimal effect to users. For more information about creating security policies, see the Firewall Guide.

Load sharing

Load sharing allows you to use both connections to the Internet at the same time, but does not provide failover
support. When configuring load sharing, you need to make sure that routing is configured for both external ports
(for example, WAN1 and WAN2) have static routes with the same distance and priority.

For more information about load sharing, see the Advanced Routing Guide.

Link redundancy and load sharing

In this scenario, both links are available to distribute Internet traffic over both links. Should one of the interfaces
fail, the FortiGate unit will continue to send traffic over the other active interface. Configuration is similar to the
Redundant interfaces configuration, with the main difference being that the configured routes should have equal
distance settings.
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This means both routes will remain active in the routing table. To make one interface the preferred interface, use
a default policy route to indicate the interface that is preferred for accessing the Internet. If traffic matches the
security policy, the policy overrides all entries in the routing table, including connected routes. You may need to
add specific policy routes that override these default policy routes.

To redirect traffic over the secondary interface, create policy routes to direct some traffic onto it rather than the
primary interface. When adding the policy route, only define the outgoing interface and leave the gateway blank.
This ensures that the policy route will not be active when the link is down.

SSL VPN and WAN link load balancing

You can set virtual WAN link interfaces as destination interfaces in firewall policies for WAN link load balancing,
when SSL VPN is the source interface. For example, you can log in to FortiGate using an SSL VPN for traffic
inspection and then have outbound traffic load balanced byWAN link load balancing.

You can set a virtual WAN link interface as a destination interface in a firewall policy where SSL VPN is the source
interface, using either the FortiGate GUI (FortiOS 5.6.1 and later) or CLI.

In the CLI, use the following CLI commands:

config firewall policy
edit <policy_id>

set dstintf virtual-wan-link
end

Secondary IP addresses to an interface
If an interface is configured with a manual or static IP address, you can also add secondary static IP addresses to
the interface. Adding secondary IP addresses effectively adds multiple IP addresses to the interface. Secondary
IP addresses cannot be assigned using DCHP or PPPoE.

All of the IP addresses added to an interface are associated with the single MAC address of the physical interface
, and all secondary IP addresses are in the same VDOM as the interface that they are added to. You configure
interface status detection for gateway load balancing separately for each secondary IP addresses. As with all
other interface IP addresses, secondary IP addresses cannot be on the same subnet as any other primary or
secondary IP address assigned to a FortiGate interface unless they are in separate VDOMs.

To configure a secondary IP address, go to Network > Interfaces, select Edit orCreate New and select the
Secondary IP Address check box.

Software switch
A software switch, or soft switch, is a virtual switch that is implemented at the software, or firmware level, rather
than the hardware level. A software switch can be used to simplify communication between devices connected to
different FortiGate interfaces. For example, using a software switch, you can place the FortiGate interface
connected to an internal network on the same subnet as your wireless interfaces. Then devices on the internal
network can communicate with devices on the wireless network without any additional configuration such as
additional security policies, on the FortiGate unit.

It can also be useful if you require more hardware ports for the switch on a FortiGate unit. For example, if your
FortiGate unit has a 4-port switch, WAN1, WAN2 and DMZ interfaces, and you need one more port, you can
create a soft switch that can include the 4-port switch and the DMZ interface all on the same subnet. These types
of applications also apply to wireless interfaces and virtual wireless interfaces and physical interfaces such as
those with FortiWiFi and FortiAP unit.
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Similar to a hardware switch, a software switch functions like a single interface. A software switch has one IP
address; all of the interfaces in the software switch are on the same subnet. Traffic between devices connected to
each interface are not regulated by security policies, and traffic passing in and out of the switch are affected by
the same policy.

There are a few things to consider when setting up a software switch:

l Ensure you create a backup of the configuration.
l Ensure you have at least one port or connection such as the console port to connect to the FortiGate unit. If you

accidentally combine too many ports, you will need a way to undo any errors.
l The ports that you include must not have any link or relation to any other aspect of the FortiGate unit. For example,

DHCP servers, security policies, and so on.
l For increased security, you can create a captive portal for the switch, allowing only specific user groups access to

the resources connected to the switch.
l To add an interface to a software switch, the interface cannot be referenced by the existing configuration. It must

also have its IP address set to 0.0.0.0/0.0.0.0.

To create a software switch - CLI

config system switch-interface
edit <switch-name>

set type switch
set member <interface_list>

end
config system interface

edit <switch_name>
set ip <ip_address>
set allowaccess https ssh ping

end

Soft switch example
For this example, the wireless interface (Wi-Fi) needs to be on the same subnet as the DMZ1 interface to
facilitate wireless syncing from an iPhone and a local computer. The synching between two subnets is
problematic. By putting both interfaces on the same subnet, the synching will work. The software switch will
accomplish this.

In this example, the soft switch includes a wireless interface. Remember to configure
any wireless security before proceeding. If you leave this interface open without any
password or other security, it leaves open access to not only the wireless interface but
to any other interfaces and devices connected within the software switch.

Clear the interfaces and back up the configuration

First, ensure that the interfaces are not being used with any other security policy or other use on the FortiGate
unit. Check the Wi-Fi and DMZ1 ports to ensure that DHCP is not enabled on the interface and there are no other
dependencies with these interfaces.

Next, save the current configuration, in the event something does not work, recovery can be quick.
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Merge the interfaces

The plan is to merge the Wi-Fi port and DMZ1 port. This will create a software switch with a name of “synchro”
with an IP address of 10.10.21.12. The following steps will create the switch, add the IP address and set
administrative access for HTTPS, SSH, and Ping.

To merge the interfaces - CLI

config system switch-interface
edit synchro

set type switch
set member dmz1 wifi

end
config system interface

edit synchro
set ip 10.10.21.12
set allowaccess https ssh ping

end

Final steps

With the switch set up, you can add security policies, DHCP servers, and any other configuration that you would
normally do to configure interfaces on the FortiGate unit.

Virtual switch
Virtual switch feature enables you create virtual switches on top of the physical switch(es) with designated
interfaces/ports so that a virtual switch can build up its forwarding table through learning and forward traffic
accordingly. When traffic is forwarded among interfaces belonging to the same virtual switch, the traffic does not
need to go up to the software stack, but is forwarded directly by the switch. When traffic has to be relayed to
interfaces not on the virtual switch, the traffic will go through the normal data path and be offloaded to NP4, when
possible.

This feature is only available on mid- to high-end FortiGate units, including the 100D, 600C, 1000C, and 1240B.

To enable and configure the virtual switch, enter the following CLI commands:

config system virtual-switch
edit vs1

set physical-switch sw0
config port

edit 1
set port port1
set speed xx
set duplex xx
set status [up|down]

edit 2
set port port2
set ...

end
end

end
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Support for 802.1x fallback and 802.1x dynamic VLANs

There are four modes when enabling 802.1x on a virtual switch interface:

Mode Description

Default In this mode, it works as it did previously.

Fallback

In fallback mode, the virtual switch will be treated as a master. Only one slave can
refer to a fallback master. Those ports in the master virtual switch are always
authorized. After passing 802.1x authentication, the ports will be stay authorized
and moved to its slave virtual switch.

Dynamic-vlan In dynamic-vlan mode, the virtual switch will also be treated as a master. However,
many slaves can refer to a dynamic-vlan master. Those ports in the master virtual
switch are always un-authorized. After passing 802.1x/MAB authentication, the
ports will be set to authorized and moved to one of its slave virtual switches.

Slave
In slave mode, a master must be set through security-8021x-master attribute. A
slave virtual switch will use its master virtual switch's security-groups settings for
authentication.

CLI example for fallback mode:

config system virtual-switch
edit "fallsw"

set physical-switch "sw0"
config port

end
edit "trust"

set physical-switch "sw0"
end

config system interface
edit "fallsw"

set vdom "root"
set ip 192.168.20.1 255.255.255.0
set allowaccess ping https ssh snmp http telnet fgfm auto-ipsec radius-acct

proberesponse capwap
set type hard-switch
set security-mode 802.1X
set security-8021x-mode fallback(fallback mode master switch)
set security-groups "rds-grp"(the usergroup for 802.1x)
set snmp-index 10
next

edit "trust"
set vdom "root"
set ip 192.168.22.1 255.255.255.0
set allowaccess ping https ssh snmp http telnet fgfm auto-ipsec radius-acct

proberesponse
set type hard-switch
set security-mode 802.1X
set security-8021x-mode slave(slave mode switch)
set security-8021x-master "fallsw" (its master switch)
set snmp-index 6
next

end
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CLI example for dynamic-vlan mode:

config system virtual-switch
edit "internal"

set physical-switch "sw0"
edit "lan-trust"

set physical-switch "sw0"
next

edit "lan-vlan1000"
set physical-switch "sw0"
next

edit "lan-vlan2000"
set physical-switch "sw0"
config port
edit "internal1" (normally we should not add port in slave switch. This is used if
user wants to manually add one port in slave)
end

end
config system interface

edit "internal"
set vdom "root"
set ip 192.168.11.99 255.255.255.0
set allowaccess ping https ssh http fgfm capwap
set type hard-switch
set security-mode 802.1X
set security-8021x-mode dynamic-vlan<------dynamic-vlan mode master switch
set security-groups "rds-grp"<------the usergroup for 802.1x
set snmp-index 15
next

edit "lan-trust"
set vdom "root"
set ip 192.168.111.99 255.255.255.0
set allowaccess ping https ssh snmp http telnet fgfm auto-ipsec radius-acct

proberesponse capwap
set type hard-switch
set security-mode 802.1X
set security-8021x-mode slave<-----slave mode switch
set security-8021x-master "internal"<-----its master switch
set snmp-index 7
next

edit "lan-vlan1000"
set vdom "root"
set ip 192.168.110.1 255.255.255.0
set allowaccess ping https ssh snmp http telnet fgfm auto-ipsec radius-acct

proberesponse capwap
set type hard-switch
set security-mode 802.1X
set security-8021x-mode slave<-----slave mode switch
set security-8021x-master "internal"<-----its master switch
set security-8021x-dynamic-vlan-id 1000 <-----the matching vlan id for this virtual
switch
set snmp-index 16
next

edit "lan-vlan2000"
set vdom "root"
set ip 192.168.220.1 255.255.255.0
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set allowaccess ping https ssh snmp http telnet fgfm auto-ipsec radius-acct
proberesponse

capwap
set type hard-switch
set security-mode 802.1X
set security-8021x-mode slave
set security-8021x-master "internal"
set security-8021x-dynamic-vlan-id 2000
set snmp-index 17
end

config user group
edit "rds-grp"

set dynamic-vlan-id 4000(default vlan id if there is no vlan attribute return
from server)

set member "190"
end

Zones
Zones are a group of one or more FortiGate interfaces, both physical and virtual, that you can apply security
policies to control inbound and outbound traffic. Grouping interfaces and VLAN subinterfaces into zones
simplifies the creation of security policies where a number of network segments can use the same policy settings
and protection profiles. When you add a zone, you select the names of the interfaces and VLAN subinterfaces to
add to the zone. Each interface still has its own address and routing is still done between interfaces, that is,
routing is not affected by zones. Security policies can also be created to control the flow of intra-zone traffic.

For example, the network includes three separate groups of users representing different entities on the company
network. While each group has its own set of port and VLANs, in each area, they can all use the same security
policy and protection profiles to access the Internet. Rather than the administrator making nine separate security
policies, the administrator can add the required interfaces to a zone and create three policies, making
administration simpler.

You can configure policies for connections to and from a zone, but not between interfaces in a zone.

The following example shows how to set up a zone to include the internal interface and a VLAN.

To create a zone - web-based manager

1. Go to Network > Interfaces.
2. Select the arrow on the Create New button and select Zone.
3. Enter a zone name of Zone_1.
4. Select the required Interface Members.
5. Select OK.

To create a zone - CLI

config system zone
edit Zone_1

set interface internal VLAN_1
end
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Virtual domains
Virtual domains (VDOMs) are a method of dividing a FortiGate unit into two or more virtual units that function as
multiple independent units. A single FortiGate unit is then flexible enough to serve multiple departments of an
organization, separate organizations, or to act as the basis for a service provider’s managed security service.

VDOMs provide separate security domains that allow separate zones, user authentication, security policies,
routing, and VPN configurations. By default, each FortiGate unit has a VDOM named root. This VDOM includes
all of the FortiGate physical interfaces, modem, virtual LAN (VLAN) subinterfaces, zones, security policies,
routing settings, and VPN settings.

When a packet enters a VDOM, it is confined to that VDOM. In a VDOM, you can create security policies for
connections between VLAN subinterfaces or zones in the VDOM. Packets do not cross the virtual domain border
internally. To travel between VDOMs, a packet must pass through a firewall on a physical interface. The packet
then arrives at another VDOM on a different interface, but it must pass through another firewall before entering
the VDOM. Both VDOMs are on the same FortiGate unit. Inter-VDOMs change this behavior because they are
internal interfaces; however, their packets go through all the same security measures as on physical interfaces.

The following example shows how to enable VDOMs on the FortiGate unit and the basic and create a VDOM
accounting on the DMZ2 port and assign an administrator to maintain the VDOM. First, enable VDOMs on the
FortiGate unit. When you enable VDOMs, the FortiGate unit will log you out.

For desktop and low-end FortiGate units, you use the CLI to enable VDOMs. Once you enable VDOMs, all further
configuration can be done using the web-based manager or the CLI. On larger FortiGate units, you can use the
web-based manager or the CLI to enable VDOMs.

To enable VDOMs - web-based manager

1. Go to Dashboard.
2. In the System Information widget, select Enable for Virtual Domain.
The FortiGate unit logs you out. Once you log back in, you will notice that the menu structure has changed. This
reflects the global settings for all VDOMs:

To enable VDOMs - CLI

config system global
set vdom-admin enable

end

Next, add the VDOM called accounting.

To add a VDOM - web-based manager

1. Go to System > VDOM, and select Create New.
2. Enter the VDOM name accounting.
3. Select OK.

To add a VDOM - CLI

config vdom
edit <new_vdom_name>

end
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With the VDOM created, you can assign a physical interface to it, and assign it an IP address.

To assign physical interface to the accounting Virtual Domain - web-based manager

1. Go to Network > Interfaces.
2. Select the DMZ2 port row and select Edit.
3. For the Virtual Domain drop-down list, select accounting.
4. Select the Addressing Mode of Manual.
5. Enter the IP address for the port of 10.13.101.100/24.
6. Set the Administrative Access to HTTPS and SSH.
7. Select OK.

To assign physical interface to the accounting Virtual Domain - CLI

config global
config system interface

edit dmz2
set vdom accounting
set ip 10.13.101.100/24
set allowaccess https ssh

next
end

VXLANs
Virtual Extensible LAN (VXLAN) is a network virtualization technology that's used in large cloud computing
deployments. It encapsulates OSI layer 2 Ethernet frames within layer 3 IP packets using the standard
destination port 4789. VXLAN endpoints that terminate VXLAN tunnels can be virtual or physical switch ports, and
are known as VXLAN Tunnel Endpoints (VTEPs). For more information about VXLAN, see RFC 7348.

VTEP support

FortiOS supports native VXLAN. You can configure VXLANs in the FortiGate CLI.

config system vxlan
edit <vxlan1> //VXLAN device name (Unique name in system.interface)

set interface //Local outgoing interface
set vni //VXLAN network ID
set ip-version //IP version to use for VXLAN device
set dstport //VXLAN destination port, default is 4789
set multicast-ttl //VXLAN multicast TTL
set remote-ip //Remote IP address of VXLAN

next
end

This creates a VXLAN interface:

show system interface vxlan1
config system interface

edit "vxlan1"
set vdom "root"
set type vxlan
set snmp-index 36
set macaddr 8a:ee:1d:5d:ae:53
set interface "port9"
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next
end

To verify the new VXLAN interface, go to Network > Interfaces in the FortiGate GUI.

To diagnose the VXLAN configuration, use the following command in the FortiGate CLI:

diagnose sys vxlan fdb list vxlan1

This command provides information about the VXLAN forwarding database (fdb) that's associated with the vxlan1
interface. The following is a sample output:

-----------mac=00:00:00:00:00:00 state=0x0082 flags=0x00-----------
-----------remote_ip=2.2.2.2 remote_port=4789-----------
-----------remote_vni=1 remote_ifindex=19-----------
total fdb num: 1

VXLAN support for multiple remote IP addresses

VXLAN is supported for multiple remote IP addresses, which can be IPv4 unicast, IPv6 unicast, IPv4 multicast, or
IPv6 multicast. This is useful in datacenter scenarios where you can configure the FortiGate with multiple tunnels
to computer nodes.

CLI changes

set ip-version option can be set to the following:

ipv4-unicast//Use IPv4 unicast addressing for VXLAN.

ipv6-unicast //Use IPv6 unicast addressing for VXLAN.

ipv4-multicast//Use IPv4 multicast addressing for VXLAN.

ipv6-multicast//Use IPv6 multicast addressing for VXLAN.

When ip-version is set to ipv4-multicast or ipv6-multicast, the ttl option is replaced by
multicast-ttl.

Wireless
Awireless interface is similar to a physical interface except it does not include a physical connection. The
FortiWiFi units allow you to add multiple wireless interfaces that can be available at the same time. On FortiWiFi
units, you can configure the device to be either an access point or a wireless client. As an access point, the
FortiWiFi unit can have separate SSIDs, each on their own subnet for wireless access. In client mode, the
FortiWiFi has only one SSID, and is used as a receiver to allow remote users to connect to the existing network
using wireless protocols.

Wireless interfaces also require additional security measures to ensure the session does not get hijacked and
data tampered or stolen.

For more information about configuring wireless interfaces see the DeployingWireless Networks Guide.
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VLANs
Virtual Local Area Networks (VLANs) multiply the capabilities of your FortiGate unit, and can also provide added
network security. VLANs use ID tags to logically separate devices on a network into smaller broadcast domains.
These smaller domains forward packets only to devices that are part of that VLAN domain. This reduces traffic
and increases network security. The IEEE 802.1Q standard defines VLANs. All layer-2 and layer-3 devices along a
route must be 802.1Q-compliant to support VLANs along that route.

A Local Area Network (LAN) is a group of connected computers and devices that are arranged into network
broadcast domains. A LAN broadcast domain includes all the computers that receive a packet broadcast from any
computer in that broadcast domain. A switch will automatically forward the packets to all of its ports. In contrast,
routers do not automatically forward network broadcast packets. This means routers separate broadcast
domains. If a network has only switches and no routers, that network is considered one broadcast domain, no
matter how large or small it is. Smaller broadcast domains are more efficient because fewer devices receive
unnecessary packets. They are more secure as well because a hacker reading traffic on the network will have
access to only a small portion of the network instead of the entire network’s traffic.

VLANs reduce the size of the broadcast domains by only forwarding packets to interfaces that are part of that
VLAN or part of a VLAN trunk link. Trunk links form switch-to-switch or switch-to-router connections, and forward
traffic for all VLANs. This enables a VLAN to include devices that are part of the same broadcast domain, but
physically distant from each other.

VLAN ID tags consist of a 4-byte frame extension that switches and routers apply to every packet sent and
received in the VLAN. Workstations and desktop computers, which are commonly originators or destinations of
network traffic, are not an active part of the VLAN process. All the VLAN tagging and tag removal is done after the
packet has left the computer.

Any FortiGate unit without VDOMs enabled can have a maximum of 255 interfaces in transparent operating
mode. The same is true for any single VDOM. In NAT mode, the number can range from 255 to 8192 interfaces
per VDOM, depending on the FortiGate model. These numbers include VLANs, other virtual interfaces, and
physical interfaces. To have more than 255 interfaces configured in transparent operating mode, you need to
configure multiple VDOMs that enable you to divide the total number of interfaces over all the VDOMs.

One example of an application of VLANs is a company’s accounting department. Accounting computers may be
located at both main and branch offices. However, accounting computers need to communicate with each other
frequently and require increased security. VLANs allow the accounting network traffic to be sent only to
accounting computers and to connect accounting computers in different locations as if they were on the same
physical subnet.

This guide uses the term “packet” to refer to both layer-2 frames and layer-3 packets.

On a layer-2 switch, you can have only one VLAN subinterface per physical interface, unless that interface is
configured as a trunk link. Trunk links can transport traffic for multiple VLANs to other parts of the network.

On a FortiGate unit, you can add multiple VLANs to the same physical interface. However, VLAN subinterfaces
added to the same physical interface cannot have the same VLAN ID or have IP addresses on the same subnet.
You can add VLAN subinterfaces with the same VLAN ID to different physical interfaces.

Creating VLAN subinterfaces with the same VLAN ID does not create an internal connection between them. For
example a VLAN ID of 300 on port1 and VLAN ID of 300 on port2 are allowed, but they are not connected. Their
relationship is the same as between any two FortiGate network interfaces.

FortiGate unit interfaces cannot have overlapping IP addresses, the IP addresses of all interfaces must be on
different subnets. This rule applies to both physical interfaces and to virtual interfaces such as VLAN
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subinterfaces. Each VLAN subinterface must be configured with its own IP address and netmask. This rule helps
prevent a broadcast storm or other similar network problems.

The following example shows how to add a VLAN, called vlan_accounting, on the FortiGate unit internal interface
with an IP address of 10.13.101.101.

To add a VLAN - web-based manager

1. Go to Network > Interfaces.
2. Select Create New and click on Interface.

The Type is set to VLAN, by default.

3. Enter a name for the VLAN to vlan_accounting.
4. Select the Internal interface.
5. Enter the VLAN ID.

The VLAN ID is a number between 1 and 4094 that allow groups of IP addresses with the same VLAN
ID to be associated together.

6. Select the Addressing Mode of Manual.
7. Enter the IP address for the port of 10.13.101.101/24.
8. Set the Administrative Access to HTTPS and SSH.
9. Select OK.

To add a VLAN - CLI

config system interface
edit VLAN_1

set interface internal
set type vlan
set vlanid 100
set ip 10.13.101.101/24
set allowaccess https ssh

next
end

VLANs in NAT mode

In NAT mode the FortiGate unit functions as a layer-3 device. In this mode, the FortiGate unit controls the flow of
packets between VLANs, but can also remove VLAN tags from incoming VLAN packets. The FortiGate unit can
also forward untagged packets to other networks, such as the Internet.

In NAT mode, the FortiGate unit supports VLAN trunk links with IEEE 802.1Q-compliant switches, or routers. The
trunk link transports VLAN-tagged packets between physical subnets or networks. When you add VLAN sub-
interfaces to the FortiGate unit physical interfaces, the VLANs have IDs that match the VLAN IDs of packets on
the trunk link. The FortiGate unit directs packets with VLAN IDs to sub-interfaces with matching IDs.

You can define VLAN sub-interfaces on all FortiGate physical interfaces. However, if multiple virtual domains are
configured on the FortiGate unit, you will have access to only the physical interfaces on your virtual domain. The
FortiGate unit can tag packets leaving on a VLAN subinterface. It can also remove VLAN tags from incoming
packets and add a different VLAN tag to outgoing packets.

Normally in VLAN configurations, the FortiGate unit's internal interface is connected to a VLAN trunk, and the
external interface connects to an Internet router that is not configured for VLANs. In this configuration the
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FortiGate unit can apply different policies for traffic on each VLAN interface connected to the internal interface,
which results in less network traffic and better security.

Adding VLAN subinterfaces

A VLAN subinterface, also called a VLAN, is a virtual interface on a physical interface. The subinterface allows
routing of VLAN tagged packets using that physical interface, but it is separate from any other traffic on the
physical interface.

Adding a VLAN subinterface includes configuring:

l Physical interface
l IP address and netmask
l VLAN ID
l VDOM

Physical interface

The term VLAN subinterface correctly implies the VLAN interface is not a complete interface by itself. You add a
VLAN subinterface to the physical interface that receives VLAN-tagged packets. The physical interface can
belong to a different VDOM than the VLAN, but it must be connected to a network router that is configured for this
VLAN. Without that router, the VLAN will not be connected to the network, and VLAN traffic will not be able to
access this interface. The traffic on the VLAN is separate from any other traffic on the physical interface.

When you are working with interfaces on your FortiGate unit, use the Column Settings on the Interface display
to make sure the information you need is displayed. When working with VLANs, it is useful to position the VLAN
ID column close to the IP address. If you are working with VDOMs, including the Virtual Domain column as well
will help you troubleshoot problemsmore quickly.

To view the Interface display, go to Network > Interfaces.

IP address and netmask

FortiGate unit interfaces cannot have overlapping IP addresses. The IP addresses of all interfaces must be on
different subnets. This rule applies to both physical and virtual interfaces, such as VLAN subinterfaces. Each
VLAN subinterface must be configured with its own IP address and netmask pair. This rule helps prevent a
broadcast storm or other similar network problems.

If you are unable to change your existing configurations to prevent IP overlap, enter
the CLI command config system settings and set allow-subnet-
overlap enable to allow IP address overlap. If you enter this command, multiple
VLAN interfaces can have an IP address that is part of a subnet used by another
interface. This command is recommended for advanced users only.

VLAN ID

The VLAN ID is part of the VLAN tag added to the packets by VLAN switches and routers. The VLAN ID is a
number between 1 and 4094 that allow groups of IP addresses with the same VLAN ID to be associated together.
VLAN ID 0 is used only for high priority frames, and 4095 is reserved.
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All devices along a route must support the VLAN ID of the traffic along that route. Otherwise, the traffic will be
discarded before reaching its destination. For example, if your computer is part of VLAN_100 and a co-worker on
a different floor of your building is also on the same VLAN_100, you can communicate with each other over
VLAN_100, only if all the switches and routers support VLANs and are configured to pass along VLAN_100 traffic
properly. Otherwise, any traffic you send to your co-worker will be blocked or will not be delivered.

VDOM

If VDOMs are enabled, each VLAN subinterface must belong to a VDOM. This rule also applies for physical
interfaces.

Interface-related CLI commands require a VDOM to be specified, regardless of
whether the FortiGate unit has VDOMs enabled.

VLAN subinterfaces on separate VDOMs cannot communicate directly with each other. In this situation, the
VLAN traffic must exit the FortiGate unit and re-enter the unit, passing through firewalls in both directions. This
situation is the same for physical interfaces.

A VLAN subinterface can belong to a different VDOM than the physical interface it is part of. This is because the
traffic on the VLAN is handled separately from the other traffic on that interface. This is one of the main strengths
of VLANs.

The following procedure will add a VLAN subinterface called VLAN_100 to the FortiGate internal interface with a
VLAN ID of 100. It will have an IP address and netmask of 172.100.1.1/255.255.255.0, and allow HTTPS
and PING administrative access. Note that in the CLI, you must enter “set type vlan” before setting the
vlanid, and that the allowaccess protocols are lower case.

To add a VLAN subinterface in NAT mode - web-based manager

1. If Current VDOM appears at the bottom left of the screen, select Global from the list of VDOMs.
2. Go to Network > Interfaces.
3. Select Create New to add a VLAN subinterface.
4. Enter the following:

VLAN Name VLAN_100

Type VLAN

Interface internal

VLAN ID 100

Addressing Mod Manual

IP/Netmask 172.100.1.1/255.255.255.0

Administrative Access HTTPS, PING, TELNET

5. Select OK.
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To view the new VLAN subinterface, select the expand arrow next to the parent physical interface (the internal
interface). This will expand the display to show all VLAN subinterfaces on this physical interface. If there is no
expand arrow displayed, there are no subinterfaces configured on that physical interface.

For each VLAN, the list displays the name of the VLAN, and, depending on column settings, its IP address, the
Administrative access you selected for it, the VLAN ID number, and which VDOM it belongs to if VDOMs are
enabled.

To add a VLAN subinterface in NAT mode - CLI

config system interface
edit VLAN_100

set interface internal
set type vlan
set vlanid 100
set ip 172.100.1.1 255.255.255.0
set allowaccess https ping

end

Configuring security policies and routing

Once you have created a VLAN subinterface on the FortiGate unit, you need to configure security policies and
routing for that VLAN. Without these, the FortiGate unit will not pass VLAN traffic to its intended destination.
Security policies direct traffic through the FortiGate unit between interfaces. Routing directs traffic across the
network.

Configuring security policies

Security policies permit communication between the FortiGate unit’s network interfaces based on source and
destination IP addresses. Interfaces that communicate with the VLAN interface need security policies to permit
traffic to pass between them and the VLAN interface.

Each VLAN needs a security policy for each of the following connections the VLAN will be using:

l From this VLAN to an external network
l From an external network to this VLAN
l From this VLAN to another VLAN in the same virtual domain on the FortiGate unit
l From another VLAN to this VLAN in the same virtual domain on the FortiGate unit

The packets on each VLAN are subject to antivirus scans and other security profiles measures as they pass
through the FortiGate unit.

Configuring routing

As a minimum, you need to configure a default static route to a gateway with access to an external network for
outbound packets. In more complex cases, you must configure different static or dynamic routes based on packet
source and destination addresses.

As with firewalls, you must configure routes for VLAN traffic. VLANs need routing and a gateway configured to
send and receive packets outside their local subnet just as physical interfaces do. The type of routing you
configure, static or dynamic, will depend on the routing used by the subnet and interfaces you are connecting to.
Dynamic routing can be routing information protocol (RIP), border gateway protocol (BGP), open shortest path
first (OSPF), or multicast.
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If you enable SSH, PING, HTTPS and HTTP on the VLAN, you can use those protocols to troubleshoot your
routing and test that it is properly configured. Enabling logging on the interfaces and using CLI diagnose
commands, such as diagnose sniff packet <interface_name>, can also help locate any possible
configuration or hardware issues.

VLANs in transparent mode

In transparent mode, the FortiGate unit behaves like a layer-2 bridge but can still provide services such as
antivirus scanning, web filtering, spam filtering and intrusion protection to traffic. There are some limitations in
transparent mode because you cannot use SSL VPN, PPTP/L2TP VPN, DHCP server, or easily perform NAT on
traffic. The limits in transparent mode apply to IEEE 802.1Q VLAN trunks passing through the unit.

VLANs and transparent mode

You can insert the FortiGate unit operating in transparent mode into the VLAN trunk without making changes to
your network. In a typical configuration, the FortiGate unit internal interface accepts VLAN packets on a VLAN
trunk from a VLAN switch or router connected to internal network VLANs. The FortiGate external interface
forwards VLAN-tagged packets through another VLAN trunk to an external VLAN switch or router and on to
external networks such as the Internet. You can configure the unit to apply different policies for traffic on each
VLAN in the trunk.

To pass VLAN traffic through the FortiGate unit, add two VLAN subinterfaces with the same VLAN ID, one to the
internal interface and the other to the external interface. You then create a security policy to permit packets to
flow from the internal VLAN interface to the external VLAN interface. If required, you create another security
policy to permit packets to flow from the external VLAN interface to the internal VLAN interface. Typically in
transparent mode, you do not permit packets to move between different VLANs. Network protection features,
such as spam filtering, web filtering, and anti-virus scanning, are applied through the Security Profiles specified in
each security policy, enabling very detailed control over traffic.

When the FortiGate unit receives a VLAN-tagged packet at a physical interface, it directs the packet to the VLAN
subinterface with the matching VLAN ID. The VLAN tag is removed from the packet, and the FortiGate unit then
applies security policies using the same method it uses for non-VLAN packets. If the packet exits the FortiGate
unit through a VLAN subinterface, the VLAN ID for that subinterface is added to the packet and the packet is sent
to the corresponding physical interface.

General configuration steps

There are two essential steps to configure your FortiGate unit to work with VLANs in transparent mode:

l Add VLAN subinterfaces
l Create security policies

You can also configure the Security Profiles that manage antivirus scanning, web filtering and spam filtering. For
more information about Security Profiles, see the Security Profiles Guide.

Add VLAN subinterfaces

The VLAN ID of each VLAN subinterface must match the VLAN ID added by the IEEE 802.1Q-compliant router or
switch. The VLAN ID can be any number between 1 and 4094, with 0 being used only for high priority frames and
4095 being reserved. You add VLAN subinterfaces to the physical interface that receives VLAN-tagged packets.

For this example, we are creating a VLAN called internal_v225 on the internal interface, with a VLAN ID of 225.
Administrative access is enabled for HTTPS and SSH. VDOMs are not enabled.
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To add VLAN subinterfaces in transparent mode - web-based manager

1. Go to Network > Interfaces.
2. Select Create New and click on Interfaces.
3. Enter the following information and select OK.

Name internal_v225

Type VLAN

Interface internal

VLAN ID 225

Administrative Access Enable HTTPS, and SSH. These are very secure access methods.

The FortiGate unit adds the new subinterface to the interface that you selected.

Repeat steps 2 and 3 to add additional VLANs. You will need to change the VLAN ID, Name, and possibly
Interfacewhen adding additional VLANs.

To add VLAN subinterfaces in transparent mode - CLI

config system interface
edit internal_v225

set interface internal
set vlanid 225
set allowaccess HTTPS SSH
set description “VLAN 225 on internal interface”
set vdom root

end

Create security policies

In transparent mode, the FortiGate unit performs antivirus and antispam scanning on each VLAN’s packets as
they pass through the unit. You need security policies to permit packets to pass from the VLAN interface where
they enter the unit to the VLAN interface where they exit the unit. If there are no security policies configured, no
packets will be allowed to pass from one interface to another.

To add security policies for VLAN subinterfaces - web based manager

1. Go to Policy & Objects > Addresses.
2. Select Create New to add firewall addresses that match the source and destination IP addresses of VLAN

packets.
3. Go to Policy & Objects > IPv4 Policy or Policy & Objects > IPv6Policy and select Create New.
4. From the Incoming Interface/Zone list, select the VLAN interface where packets enter the unit.
5. From theOutgoing Interface/Zone list, select the VLAN interface where packets exit the unit.
6. Select the Source and Destination Address names that you added in step 2.
7. Select OK.

To add security policies for VLAN subinterfaces - CLI

config firewall address
edit incoming_VLAN_address
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set associated-interface <incoming_VLAN_interface>
set type ipmask
set subnet <IPv4_address_mask)

next
edit outgoing_VLAN_address

set associated-interface <outgoing_VLAN_interface>
set type ipmask
set subnet <IPv4_address_mask>

next
end
config firewall policy or config firewall policy6

edit <unused_policy_number>
set srcintf <incoming_VLAN_interface>
set srcaddr incoming_VLAN_address
set destintf <outgoing_VLAN_interface>
set destaddr outgoing_VLAN_address
set schedule always
set service <protocol_to_allow_on VLAN>
set action ACCEPT

next
end

VLAN switching and routing

VLAN switching takes place on the Open Systems Interconnect (OSI) model layer-2, just like other network
switching. VLAN routing takes place on the OSI model layer-3. The difference between them is that during VLAN
switching, VLAN packets are simply forwarded to their destination. This is different from VLAN routing where
devices can open the VLAN packets and change their VLAN ID tags to route the packets to a new destination.

VLAN layer-2 switching

Ethernet switches are layer-2 devices, and generally are 802.1Q compliant. Layer 2 refers to the second layer of
the seven layer OSI basic networking model, called the Data Link layer. FortiGate units act as layer-2 switches or
bridges when they are in transparent mode. The units simply tag and forward the VLAN traffic or receive and
remove the tags from the packets. A layer-2 device does not inspect incoming packets or change their contents; it
only adds or removes tags and routes the packet.

A VLAN can have any number of physical interfaces assigned to it. Multiple VLANs can be assigned to the same
physical interface. Typically two or more physical interfaces are assigned to a VLAN, one for incoming and one for
outgoing traffic. Multiple VLANs can be configured on one FortiGate unit, including trunk links.

VLAN layer-3 routing

Routers are layer-3 devices. Layer 3 refers to the third layer of the OSI networking model, the Network layer.
FortiGate units in NAT mode act as layer-3 devices. As with layer 2, FortiGate units acting as layer-3 devices are
802.1Q-compliant.

The main difference between layer-2 and layer-3 devices is how they process VLAN tags. Layer-2 switches just
add, read and remove the tags. They do not alter the tags or do any other high-level actions. Layer-3 routers not
only add, read and remove tags but also analyze the data frame and its contents. This analysis allows layer-3
routers to change the VLAN tag if it is appropriate and send the data frame out on a different VLAN.

In a layer-3 environment, the 802.1Q-compliant router receives the data frame and assigns a VLAN ID. The
router then forwards the data frame to other members of the same VLAN broadcast domain. The broadcast
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domain can include local ports, layer-2 devices and layer-3 devices such as routers and firewalls. When a layer-3
device receives the data frame, the device removes the VLAN tag and examines its contents to decide what to do
with the data frame. The layer-3 device considers:

l Source and destination addresses
l Protocol
l Port number

The data frame may be forwarded to another VLAN, sent to a regular non-VLAN-tagged network or just forwarded
to the same VLAN as a layer-2 switch would do. Or, the data frame may be discarded if the proper security policy
has been configured to do so.

Layer-2 and ARP traffic

By default, FortiGate units do not pass layer-2 traffic. If there are layer-2 protocols such as IPX, PPTP or L2TP in
use on your network, you need to configure your FortiGate unit interfaces to pass these protocols without
blocking. Another type of layer-2 traffic is Address Resolution Protocol (ARP) traffic.

You can allow these layer-2 protocols using the CLI command:

config system interface
edit <name_str>

set l2forward enable
end

where <name_str> is the name of an interface.

If VDOMs are enabled, this command is per VDOM. You must set it for each VDOM that has the problem as
follows:

config vdom
edit <vdom_name>

config system interface
edit <name_str>
set l2forward enable

end
end

If you enable layer-2 traffic, you may experience a problem if packets are allowed to repeatedly loop through the
network. This repeated looping, very similar to a broadcast storm, occurs when you have more than one layer-2
path to a destination. Traffic may overflow and bring your network to a halt. You can break the loop by enabling
Spanning Tree Protocol (STP) on your network’s switches and routers.

STP forwarding

The FortiGate unit does not participate in the Spanning Tree Protocol (STP). STP is an IEEE 802.1 protocol that
ensures there are no layer-2 loops on the network. Loops are created when there is more than one route for traffic
to take and that traffic is broadcast back to the original switch. This loop floods the network with traffic, reducing
available bandwidth to nothing.

If you use your FortiGate unit in a network topology that relies on STP for network loop protection, you need to
make changes to your FortiGate configuration. Otherwise, STP recognizes your FortiGate unit as a blocked link
and forwards the data to another path. By default, your FortiGate unit blocks STP as well as other non-IP protocol
traffic.
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Using the CLI, you can enable forwarding of STP and other layer-2 protocols through the interface. In this
example, layer-2 forwarding is enabled on the external interface:

config system interface
edit external

set l2forward enable
set stpforward enable

end

By substituting different commands for stpforward enable, you can also allow layer-2 protocols such as
IPX, PPTP or L2TP to be used on the network.

STP support for FortiGate models with hardware switches

STP (Spanning Tree Protocol) used to be available only on the old style switch mode for the internal ports. You
can now activate STP on the hardware switches found in the newer FortiGate models. These models use a virtual
switch to simulate the old switch Mode for the internal ports.

You can enable STP, using the following CLI commands:

config system interface
edit lan
set stp [enable | disable]
end

ARP traffic

Address Resolution Protocol (ARP) packets are vital to communication on a network and ARP support is enabled
on FortiGate unit interfaces, by default. Normally you want ARP packets to pass through the FortiGate unit,
especially if it is sitting between a client and a server or between a client and a router.

ARP traffic can cause problems, especially in transparent mode where ARP packets arriving on one interface are
sent to all other interfaces including VLAN subinterfaces. Some layer-2 switches become unstable when they
detect the same MAC address originating on more than one switch interface or from more than one VLAN. This
instability can occur if the layer-2 switch does not maintain separate MAC address tables for each VLAN.
Unstable switches may reset and cause network traffic to slow down considerably.

The default ARP timeout value is 5 minutes (300 seconds). So usually ARP entries are removed after 5 minutes.
However, some conditions can cause ARP entries to remain on the list for a longer time. This is not a configurable
value. To view the ARP list, enter the get system arp CLI command.

Proxy ARP extensions

You can extend the proxy ARP configuration to an IP address range instead of a single IP address. When you
configure proxy-arp, in addition to setting the IP address, you can also set the end-ip address. If you do not
set this, the proxy ARPwill be a single address, as before. The following is an example CLI configuration, using
the new setting:

config system proxy-arp
edit 1

set interface "internal"
set ip 192.168.1.100
set end-ip 192.168.1.102
end

2461 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Interfaces

Multiple VDOMs solution

By default, physical interfaces are in the root domain. If you do not configure any of your VLANs in the root
VDOM, it will not matter how many interfaces are in the root VDOM.

The multiple VDOMs solution is to configure multiple VDOMs on the FortiGate unit, one for each VLAN. In this
solution, you configure one inbound and one outbound VLAN interface in each VDOM. ARP packets are not
forwarded between VDOMs. This configuration limits the VLANs in a VDOM and correspondingly reduces the
administration needed per VDOM.

As a result of this configuration, the switches do not receive multiple ARP packets with duplicate MACs. Instead,
the switches receive ARP packets with different VLAN IDs and different MACs. Your switches are stable.

However, you should not use the multiple VDOMs solution under any of the following conditions:

l You have more VLANs than licensed VDOMs
l You do not have enough physical interfaces

Instead, use one of two possible solutions, both supported in transparent mode only:

l Use the vlanforward CLI command.
l Use the forward-domain CLI command. But you still need to be careful in some rare configurations.

Vlanforward solution

By default, the vlanforward CLI command is enabled and will forward VLAN traffic to all VLANs on this
interface. When disabled, each VLAN on this physical interface can send traffic only to the same VLAN. There is
no cross-talk between VLANs, and ARP packets are forced to take one path along the network which prevents the
multiple paths problem.

In the following example, vlanforward is disabled on port1. All VLANs configured on port1 will be separate
and will not forward any traffic to each other.

config system interface
edit port1

set vlanforward disable
end

Forward-domain solution

If you are using transparent mode, the solution is to use the forward-domain CLI command. This command
tags VLAN traffic as belonging to a particular collision group, and only VLANs tagged as part of that collision
group receive that traffic. It is like an additional set of VLANs. By default, all interfaces and VLANs are part of
forward-domain collision group 0. The many benefits of this solution include reduced administration, the need for
fewer physical interfaces, and the availability of more flexible network solutions.

In the following example, forward-domain collision group 340 includes VLAN 340 traffic on port1 and untagged
traffic on port 2. Forward-domain collision group 341 includes VLAN 341 traffic on port 1 and untagged traffic on
port 3. All other interfaces are part of forward-domain collision group 0 by default. This configuration separates
VLANs 340 and 341 from each other on port 1.

Use these CLI commands:

config system interface
edit port2

set forward_domain 340

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2462



Interfaces

next
edit port3

set forward_domain 341
next
edit port1-340

set forward_domain 340
set interface port1
set vlanid 340

next
edit port1-341

set forward_domain 341
set interface port1
set vlanid 341

end

You may experience connection issues with layer-2 traffic, such as ping, if your network configuration has:

l Packets going through the FortiGate unit in transparent mode more than once
l More than one forwarding domain (such as incoming on one forwarding domain and outgoing on another)
l IPS and AV enabled

Now IPS and AV is applied the first time packets go through the FortiGate unit, but not on subsequent passes.
Applying IPS and AV only to this first pass fixes the network layer-2 related connection issues.

Asymmetric routing

You might discover unexpectedly that hosts on some networks are unable to reach certain other networks. This
occurs when request and response packets follow different paths. If the FortiGate unit recognizes the response
packets, but not the requests, it blocks the packets as invalid. Also, if the FortiGate unit recognizes the same
packets repeated on multiple interfaces, it blocks the session as a potential attack.

This is asymmetric routing. By default, the FortiGate unit blocks packets or drops the session when this happens.
You can configure the FortiGate unit to permit asymmetric routing by using the following CLI commands:

config system settings
set asymroute enable

end

If VDOMs are enabled, this command is per VDOM. You must set it for each VDOM that has the problem as
follows:

config vdom
edit <vdom_name>

config system settings
set asymroute enable

end
end

If this solves your blocked traffic issue, you know that asymmetric routing is the cause. But allowing asymmetric
routing is not the best solution, because it reduces the security of your network.

For a long-term solution, it is better to change your routing configuration or change how your FortiGate unit
connects to your network.
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If you enable asymmetric routing, antivirus and intrusion prevention systems will not
be effective. Your FortiGate unit will be unaware of connections and treat each packet
individually. It will become a stateless firewall.

Configuring IPv4 and IPv6 ICMP traffic inspection

In order for the inspection of asymmetric ICMP traffic not to affect TCP and UDP traffic, you can enable or disable
ICMP traffic inspection for traffic being routed asymmetrically for both IPv4 and IPv6.

To configure ICMP traffic inspeciton, use the following CLI commands:

l IPv4:

config system settings
set asymroute-icmp
end

l IPv6:

config system settings
set asymroute6-icmp
end

NetBIOS

Computers running Microsoft Windows operating systems that are connected through a network rely on a WINS
server to resolve host names to IP addresses. The hosts communicate with the WINS server by using the
NetBIOS protocol.

To support this type of network, you need to enable the forwarding of NetBIOS requests to a WINS server. The
following example will forward NetBIOS requests on the internal interface for the WINS server located at an IP
address of 192.168.111.222.

config system interface
edit internal

set netbios_forward enable
set wins-ip 192.168.111.222

end

These commands apply only in NAT mode. If VDOMs are enabled, these commands are per VDOM. You must
set them for each VDOM that has the problem.

Too many VLAN interfaces

Any virtual domain can have a maximum of 255 interfaces in transparent mode. This includes VLANs, other
virtual interfaces, and physical interfaces. NAT mode supports from 255 to 8192 depending on the FortiGate
model. This total number of interfaces includes VLANs, other virtual interfaces, and physical interfaces.

Your FortiGate unit may allow you to configure more interfaces than this. However, if you configure more than
255 interfaces, your system will become unstable and, over time, will not work properly. As all interfaces are
used, they will overflow the routing table that stores the interface information, and connections will fail. When you
try to add more interfaces, an error message will state that the maximum limit has already been reached.

If you see this error message, chances are you already have too many VLANs on your system and your routing
has become unstable. To verify, delete a VLAN and try to add it back. If you have too many, you will not be able
to add it back on to the system. In this case, you will need to remove enough interfaces (including VLANs) so that

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2464



Interfaces

the total number of interfaces drops to 255 or less. After doing this, you should also reboot your FortiGate unit to
clean up its memory and buffers, or you will continue to experience unstable behavior.

To configure more than 255 interfaces on your FortiGate unit in transparent mode, you have to configure multiple
VDOMs, each with many VLANs. However, if you want to create more than the default 10 VDOMs (or a maximum
of 2550 interfaces), you must buy a license for additional VDOMs and your FortiGate must be able to be licensed
for more than 10 VDOMs.

With these extra licenses, you can configure up to 500 VDOMs, with each VDOM containing up to 255 VLANs in
transparent mode. This is a theoretical maximum of over 127 500 interfaces. However, system resources will
quickly get used up before reaching that theoretical maximum. To achieve the maximum number of VDOMs, you
need to have top-end hardware with the most resources possible.

In NAT mode, if you have a top-end model, the maximum interfaces per VDOM can be as high as 8192, which is
enough for all the VLANs in your configuration.

Your FortiGate unit has limited resources, such as CPU load and memory, that are
divided between all configured VDOMs. When running 250 or more VDOMs, you may
need to monitor the system resources to ensure there is enough to support the
configured traffic processing.

Troubleshooting VLAN issues

Several problems can occur with your VLANs. Since VLANs are interfaces with IP addresses, they behave as
interfaces and can have similar problems that you can diagnose with tools, such as ping, traceroute, packet
sniffing, and diag debug.

Botnet and command-and-control protection
You can configure botnet and command-and-control traffic protection, in the FortiGate GUI or CLI.

In the GUI, you can use select the Scan Outgoing Connections to Botnet Sites option on the Interfaces
page. The options are Disable, Block, andMonitor.

In the CLI, you can configure the botnet scan on the interface, using the following commands:

config system interface
edit <interface>

set scan-botnet-connections [disable | block | monitor]
end

You can also enable the scanning of botnet and command-and-control traffic in the following policies:

l Firewall policies:

config firewall policy
edit <policyid>

set scan-botnet-connections [disable | block | monitor]
end

l Firewall explicit proxy policies:

config firewall explicit-proxy-policy
edit <policyid>

set scan-botnet-connections [disable | block | monitor]
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end

l Firewall interface policy:

config firewall interface-policy
edit <policyid>

set scan-botnet-connections [disable | block | monitor]
end

l Firewall sniffer:

config firewall sniffer
edit <policyid>

set scan-botnet-connections [disable | block | monitor]
end

DNS

ADomain Name System (DNS) server is a public service that converts symbolic node names to IP addresses. A
DNS server implements the protocol. In simple terms, it acts as a phone book for the Internet. A DNS server
matches domain names with their computer IP addresses. This allows you to use readable locations, such as
fortinet.com, when you browse the Internet. FortiOS supports DNS configuration for both IPv4 and IPv6
addressing.

FortiGate includes default DNS server addresses. However, you should change these addresses to ones that your
Internet Service Provider (ISP) provides. The defaults are DNS proxies and are not as reliable as those from your
ISP.

Within FortiOS, there are two DNS configuration options. Each option provides a specific service and both options
can work together to provide a complete DNS solution.

DNS settings
You configure basic DNS queries on interfaces that connect to the Internet. When a user requests a website,
FortiGate looks to the configured DNS servers to provide the IP address of the website in order to know which
server to contact to complete the transaction.

You configure DNS server addresses by selecting Network > DNS, and then specifying the DNS server
addresses. These addresses are typically supplied by your ISP. If you have local Microsoft domains on the
network, you can enter a domain name in the Local Domain Name field.

In a situation where all three fields are configured, FortiGate first looks to the local domain. If no match is found,
FortiGate sends a request to the external DNS servers.

If virtual domains (VDOM) are enabled, you create a DNS database in each VDOM. All of the interfaces in a
VDOM share the DNS database in that VDOM.

Additional DNS CLI configuration
Additional DNS configuration options are available in the CLI, using the config system dns command.
Within this command, you can also set the following commands:

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2466



DNS

Command Description

dns-cache-limit Set how many DNS entries are stored in the cache. Entries that
remain in the cache provide a quicker response to requests than
going out to the Internet to get the same information.

dns-cache-ttl Set how long entries remain in the cache, in seconds. Possible
values are 60 to 86400 (default is 24 hours).

cache-notfound-responses When you enable this, any DNS requests that are returned with NOT
FOUND can be stored in the cache.

source-ip Define a dedicated IP address for communications with the DNS
server.

DDNS
If your ISP changes your external IP address on a regular basis, and you have a static domain name, you can
configure the external interface to use a dynamic DNS (DDNS) service. This ensures that external users and
customers can always connect to your company firewall. If you have a FortiGuard subscription, you can use
FortiGuard as the DDNS server.

You can configure FortiGuard as the DDNS server, in the FortiGate GUI or CLI.

To configure FortiGuard as the DDNS server in the FortiGate GUI, select Network > DNS and enable
FortiGuard DDNS. Then select the interface with the dynamic connection, which DDNS server you have an
account with, your domain name, and account information. If your DDNS server is not on the list, there is a
generic option where you can provide your DDNS server information.

To configure FortiGuard as the DDNS server in the FortiGate CLI, use the following CLI commands:

config system fortiguard
set ddns-server-ip
set ddns-server-port

end

If you do not have a FortiGuard subscription or want to use a different DDNS server, you can configure DDNS in
the CLI. You can configure a DDNS for each interface. Only the first configured port appears in the FortiGate
GUI. Additional commands vary depending on the DDNS server you select. Use the following CLI commands:

config system ddns
edit <DDNS_ID>

set monitor-interface <external_interface>
set ddns-server <ddns_server_selection>

end

Configuring FortiGate to refresh DDNS IP addresses

You can configure FortiGate to refresh DDNS IP addresses. FortiGate periodically checks the DDNS server that is
configured. Use the following CLI commands:

config system ddns
edit <1>

set ddns-server FortiGuardDDNS
set use-public-ip enable
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set update-interval seconds
end

The possible values for update-interval are 60 to 2592000 seconds, and the default is 300 seconds.

TLS support for DDNS updates

When cleartext is disabled, FortiGate uses the SSL connection to send and receive Dynamic DNS services
(DDNS) updates.

To disable cleartext, use the following CLI commands:

config system ddns
set clear-text disable
end

The ssl-certificate name can also be set in the same location using the command:

set ssl-certificate <cert_name>

DDNS update override for DHCP

DHCP server has an override command option that allows DHCP server communications to go through DDNS to
perform updates for the DHCP client. This enforces a DDS update of the AA field every time, even if the DHCP
client does not request it. This allows the support of the allow/ignore/deny client-updates options.

You can enable DDNS update override, using the following CLI commands:

config system dhcp server
edit <0>

set ddns-update_override enable
end

FortiDDNS registration to a public IP address

Fortinet's Dynamic DNS services (FortiDDNS) can be registered to a public IP address even if the FortiGate
model does not have any physical interfaces on the Internet. This applies to when FortiGate is behind other
networking devices that are employing NAT. You can configure this in the GUI and the CLI.

DNS servers
You can also create local DNS servers for your network. Depending on your requirements, you can manually
maintain your entries (master DNS server) or use it as a jumping point, where the server refers to an outside
source (slave DNS server). A local master DNS server works similarly to the DNS server addresses configured in
Network > DNS, but you must manually add all entries. This allows you to add a local DNS server to include
specific URL and IP address combinations.

The DNS server options are not visible in the FortiGate GUI, by default. To enable the server, select System
> Feature Visibility, select DNS Database, and select Apply.

While a master DNS server is an easy method to include regularly used addresses to save on going to an outside
DNS server, it is not recommended to make it the authoritative DNS server. IP addresses may change and
maintaining any type of list can become labor-intensive.

It is best to use a FortiGate master DNS server for local services. For example, a company has a web server in
their DMZ that internal users (employees) and external users (customers or remote employees) access. When
internal users access a website, a request for the website is sent out to the DNS server on the Internet, which
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then returns an IP address or virtual IP address. After the company configures an internal DNS server, the same
website request is resolved internally to the internal web server IP address. This minimizes inbound and outbound
traffic, and access time.

As a slave DNS server, FortiGate refers to an external or alternate source as a way to obtain the URL and IP
address combination. This is useful if there is a master DNS server for a large company, where a list is
maintained. Satellite offices can then connect to the master DNS server to obtain the correct addressing.

The DNS server entries do not allow CNAME entries, as per RFC 1912, section 2.4.

Configure a master DNS server - web-based manager

1. Select Network > DNS Servers, and select Create New forDNS Database.
2. Select the Type of Master.
3. Select the View asShadow.
4. The view is the accessibility of the DNS server. Selecting Public, external users can access, or use, the DNS

server. Selecting Shadow, only internal users can use it.
5. Enter the DNS Zone, for example, WebServer.
6. Enter the domain name for the zone, for example example.com.
7. Enter the hostname of the DNS server, for example, Corporate.
8. Enter the contact address for the administrator, for example, admin@example.com.
9. Set Authoritative to Disable.
10. Select OK.
11. Enter the DNS entries for the server by selecting Create New.
12. Select the Type, for example, Address (A).
13. Enter the Hostname, for example web.example.com.
14. Enter the remaining information, which varies depending on the Type selected.
15. Select OK.

Configure a master DNS server - CLI

config system dns-database
edit WebServer

set domain example.com
set type master
set view shadow
set ttl 86400
set primary-name corporate
set contact admin@exmple.com
set authoritative disable

config dns-entry
edit 1

set hostname web.example.com
set type A
set ip 192.168.21.12
set status enable

end
end
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Configuring a recursive DNS

You can set an option to ensure this type of DNS server is not the authoritative server. When configured, the
FortiGate unit will check its internal DNS server (master or slave). If the request cannot be fulfilled, it will look to
the external DNS servers. This is known as a split DNS configuration.

You can also have FortiGate look to an internal server if the master or slave does not fulfill the request, using the
following CLI commands:

config system dns-database
edit example.com

...
set view shadow

end

For this behavior to work completely, you must set the DNS query for the external interface to be recursive.

Configure a recursive DNS - web-based manager

1. Go to Network > DNS Servers, and select Create New forDNS Service on Interface.
2. Select the Interface.
3. Select theMode to Recursive.
4. Select OK.

Configure a recursive DNS - CLI

config system dns-server
edit wan1

set mode recursive
end

Configuring IPv6 Router Advertisement options for DNS configuration

FortiGate supports the following RFC 6106 IPv6 Router Advertisement options:

l Obtaining DNS search list options from upstream DHCPv6 servers
l Sending the DNS search list through Router Advertisement
l Sending the DNS search list through the FortiGate DHCP server
l Sending DNS search list option to downstream clients with Router Advertisements that use a static prefix (FortiOS

version 5.6.1 and later)
l Sending recursive DNS server option to downstream clients with Router Advertisements that use a static prefix

(FortiOS version 5.6.1 and later)

Obtain the DNS search list options from upstream DHCPv6 servers - CLI

config system interface
edit wan1

config ipv6
set dhcp6-prefix-delegation enable

next
next

end
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Send DNS search lists through Router Advertisement - CLI

config system interface
edit port 1

config IPv6
set ip6-address 2001:10::/64
set ip6-mode static
set ip6-send-adv enable
config ip6-delegated-prefix-list
edit 1

set upstream-interface WAN
set subnet 0:0:0:11::/64
set autonomous-flag enable
set onlink-flag enable

next
next

end
end

Send the DNS search lists through the FortiGate DHCP server - CLI

You can use the dns-search-list delegated command to send DNS search list option to downstream
clients with Router Advertisements that use a static prefix, using the following CLI commands:

config system dhcp6 server
edit 1

set interface port2
set upstream-interface WAN
set ip-mode delegated
set dns-service delegated
set dns-search-list delegated
set subnet 0:0:0:12::/64

next
end

Send DNS search list option to downstream clients with Router Advertisements that use a static prefix -
CLI

In FortiOS 5.6.1 and later, you can use the set dnssl <DNS search list option> command to send
DNS search list option to downstream clients with Router Advertisements that use a static prefix, using the
following CLI commands:

config system interface
edit port1

config ipv6
config ip6-prefix-list

edit <2001:db8::/64>
set autonomous-flag enable
set onlink-flag enable
set rdnss 2001:1470:8000::66 2001:1470:8000::72
set dnssl <DNS search list option>

end
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Send recursive DNS server option to downstream clients with Router Advertisements that use a static
prefix - CLI

In FortiOS 5.6.1 and later, you can use the set rdnss <recursive DNS search option> command to
send Recursive DNS server option to downstream clients with Router Advertisements that use a static prefix,
using the following CLI commands:

config system interface
edit port1

config ipv6
config ip6-prefix-list

edit <2001:db8::/64>
set autonomous-flag enable
set onlink-flag enable
set rdnss 2001:1470:8000::66 2001:1470:8000::72
set dnssl <DNS search list option>

end

Viewing the Internet Service Database

The Internet Service Database in the FortiGate GUI contains detailed information about services that are
available on the Internet, such as DNS servers that Adobe, Google, Fortinet, and Apple provide. For each service,
the database shows the IP addresses of the servers that host the service, and the port and protocol number that
each IP address uses.To view the Internet Service Database, select Policy & Objects > Internet Service
Database in the FortiGate GUI.
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Advanced static routing

Advanced static routing includes features and concepts that are used in more complex networks.

Routing concepts
Many routing concepts apply to static routing. However without first understanding these basic concepts, it is
difficult to understand the more complex dynamic routing.

Routing in VDOMs

Routing on FortiGate units is configured per-VDOM. This means if VDOMs are enabled, you must enter a VDOM
to do any routing configuration. This allows each VDOM to operate independently, with its own default routes and
routing configuration.

In this guide, the procedures assume your FortiGate unit has VDOMs disabled. This is stated in the assumptions
for the examples. If you have VDOMs enabled, you will need to perform the following steps in addition to the
procedure’s steps.

To route in VDOMs - web-based manager

Select the VDOM that you want to view or configure at the bottom of the main menu.

To route in VDOMs - CLI

Before following any CLI routing procedures with VDOMs enabled, enter the following commands. For this
example, it is assumed you will be working in the root VDOM. Change root to the name of your selected VDOM
as needed.

config vdom
edit root

Following these commands, you can enter any routing CLI commands, as normal.

Default route

The default route is used if either there are no other routes in the routing table or if none of the other routes apply
to a destination. Including the gateway in the default route gives all traffic a next-hop address to use when leaving
the local network. The gateway address is normally another router on the edge of the local network.

All routers, including FortiGate units, are shipped with default routes in place. This allows customers to set up
and become operational more quickly. Beginner administrators can use the default route settings until a more
advanced configuration is warranted.

Adding a static route

1. To add or edit a static route, go to Network > Static Routes and select Create New.
2. Enter the following information and select OK.
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Destination IP/Mask Enter the destination IP address and netmask.
A value of 0.0.0.0/0.0.0.0 is universal.

Gateway Enter the gateway IP address.

Interface Select the name of the interface that the static route will connect through.

Administrative Distance
Enter the distance value, which will affect which routes are selected first by
different protocols for route management or load balancing. The default is
10.

Advanced Options Optionally, expand Advanced Options and enter a Priority, which will
artificially weight the route during route selection. The higher the priority
number, the less likely the route is to be selected over other routes. The
default is 0.

Enabling or disabling individual static routes

You can enable or disable individual static routes.

To configure IPv4 static routes, use the following CLI commands:

config route static
edit 0

set status [enable|disable]
end

To configure IPv6 static routes, use the following CLI commands:

config route static6
edit 0

set status [enable|disable]
end

Configuring FQDNs as a destination address in static routes

You can configure FQDN firewall addresses as destination addresses in a static route, using either the GUI or the
CLI.

In the GUI, to add an FQDN firewall address to a static route in the firewall address configuration, enable the
Static Route Configuration option. Then, when configuring the static route, set Destination to Named
Address.

In the CLI, use the following CLI commands:

First, configure the firewall FQDN address:

config firewall address
edit 'Fortinet-Documentation-Website'

set type fqdn
set fqdn docs.fortinet.com
set allow-routing enable

end

Next, add the FQDN address to a static route.

config router static
edit 0
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set dstaddr Fortinet-Documentation-Website
...

end

Routing table

When two computers are directly connected, there is no need for routing because each computer knows exactly
where to find the other computer. They communicate directly.

Networking computers allows many computers to communicate with each other. This requires each computer to
have an IP address to identify its location to the other computers. This is much like a mailing address, where you
will not receive your postal mail at home if you do not have an address for people to send mail to. The routing
table on a computer is much like an address book used to mail letters to people, where the routing table
maintains a list of how to reach computers. Routing tables may also include information about the quality of
service (QoS) of the route, and the interface associated with the route if the device has multiple interfaces.

Looking at routing as delivering letters is more simple than reality. In reality, routers lose power or have bad
cabling, network equipment is moved without warning, and other such events happen that prevent static routes
from reaching their destinations. When any changes, such as these, happen along a static route, traffic can no
longer reach the destination and the route goes down. Dynamic routing can address these changes to ensure that
traffic still reaches its destination. The process of realizing there is a problem, backtracking, and finding a route
that is operational, is called convergence. If there is fast convergence in a network, users will not even know that
re-routing is taking place.

The routing table for any device on the network has a limited size. For this reason, routes that are not used are
replaced by new routes. This method ensures the routing table is always populated with the most current and
most used routes, which are the routes that have the best chance of being reused. Another method used to
maintain the routing table’s size is if a route in the table and a new route are to the same destination, one of the
routes is selected as the best route to that destination and the other route is discarded.

Routing tables are also used in unicast reverse path forwarding (uRPF). In uRPF, the router not only looks up the
destination information but it also looks up the source information to ensure that it exists. If there is no source to
be found, that packet is dropped because the router assumes it is an error or an attack on the network.

The routing table is used to store routes that are learned. The routing table for any device on the network has a
limited size. For this reason, routes that are not used are replaced by new routes. This method ensures the
routing table is always populated with the most current and most used routes, which are the routes that have the
best chance of being reused. Another method used to maintain the routing table’s size is if a route in the table
and a new route are to the same destination, one of the routes is selected as the best route to that destination
and the other route is discarded.

Viewing the routing table

You can view the routing table in the FortiGate GUI. By default, all routes are displayed in the Routing Monitor
list. The default static route is defined as 0.0.0.0/0, which matches the destination IP address of “any/all”
packets.

To display the routes in the routing table, go toMonitor > Routing Monitor. Select Static & Dynamic to view
the routes.

You can also monitor policy routes. Select Policy to list the active policy routes on the FortiGate and see
information about them. The active policy routes include policy routes that you create, SD-WAN rules, and
Internet service static routes. It also supports downstream devices in the Security Fabric.

The following figure show an example of the static and dynamic routes in the Routing Monitor list.
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The following figure show an example of the policy routes in the Routing Monitor list.

Field Description

IP Version Shows whether the route is IPv4 or IPv6.

IPv6 routes are displayed only if IPv6 is enabled in the FortiGate GUI.

Type

The type values assigned to FortiGate routes (Static, Connected, RIP, OSPF, or
BGP).

l All: all routes recorded in the routing table
l Connected:all routes associated with direct connections to FortiGate unit

interfaces
l Static: the static routes that have been added to the routing table manually
l RIP: all routes learned through RIP. For more information, see RIP on page

2519
l RIPNG: all routes learned through RIP version 6 (which enables the sharing of

routes through IPv6 networks)
l BGP: all routes learned through BGP. For more information, see BGP on

page 2598.
l OSPF: all routes learned through OSPF. For more information, see OSPF on

page 2557.
l OSPF6: all routes learned through OSPF version 6 (which enables the sharing

of routes through IPv6 networks)
l IS-IS: all routes learned through IS-IS. For more information, see IS-IS on

page 2637.
l HA: RIP, OSPF, and BGP routes synchronized between the primary unit and

the subordinate units of a high availability (HA) cluster. HA routes are
maintained on subordinate units and are visible only if you are viewing the
router monitor from a virtual domain that is configured as a subordinate virtual
domain in a virtual cluster.

For more information about HA routing synchronization, see the FortiGate HAUser
Guide.
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Field Description

Subtype If applicable, the subtype classification assigned to OSPF routes.

An empty string implies an intra-area route. The destination is in an area to which the
FortiGate unit is connected.

l OSPF inter area: the destination is in the OSPF AS, but FortiGate is not
connected to that area.

l External 1: the destination is outside the OSPF AS. This is known as OSPF
E1 type. The metric of a redistributed route is calculated by adding the
external cost and the OSPF cost together.

l External 2: the destination is outside the OSPF AS. This is known as OSPF
E2 type. In this case, the metric of the redistributed route is equivalent to the
external cost only, expressed as an OSPF cost.

l OSPF NSSA 1: same as External 1, but the route was received through a
not-so-stubby area (NSSA)

l OSPF NSSA 2: same as External 2, but the route was received through a
not-so-stubby area

For more information about OSPF subtypes, see OSPF on page 2557.

Network The IP addresses and network masks of destination networks that FortiGate can
reach.

Gateway IP The IP addresses of gateways to the destination networks.

Interfaces The interface through which packets are forwarded to the gateway of the destination
network.

Up Time The total accumulated amount of time that a route learned through RIP, OSPF, or
BGP has been reachable.

Distance

The administrative distance associated with the route. A value of 0 means the route is
preferable compared to other routes to the same destination, and the FortiGate unit
may routinely use the route to communicate with neighboring routers and access
servers.

Modifying this distance for dynamic routes is route distribution. See BGP on page
2598.
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Field Description

Metric The metric associated with the route type. The metric of a route influences how the
FortiGate unit dynamically adds it to the routing table. The following are types of
metrics and the protocols they are applied to.

Hop count: routes learned through RIP

Relative cost: routes learned through OSPF

Multi-Exit Discriminator (MED): routes learned through BGP. However, several
attributes in addition to MED determine the best path to a destination network. For
more information on BGP attributes, see BGP on page 2598. By default, the MED
value associated with a BGP route is zero. However, the MED value can be modified
dynamically. If the value was changed from the default, the Metric column will display
a non-zero value.

Not displayed when IP version 6 is selected.

Copying DSCP value in GRE tunnels

You can enable an option to allow copying of the DSCP (Differentiated services code point) value in GRE tunnels.
This feature enables the keeping of the DSCPmarking in the packets after encapsulation for going through GRE
tunnels.

To enable DSCP copying, use the following CLI commands:

config sys gre-tunnel
set dscp-copying enable

Configuring the maximum number of IP route cache entries

You can configure the maximum number of route cache entries, using the following CLI commands:

config system global
set max-route-cache-size <integer between 0 - 2147483647>
end

Unsetting the field causes the value to be set to the kernel calculated default:

config system global
unset max-route-cache-size
end

Viewing the routing table in the CLI

In the CLI, you can easily view the static routing table just as in the web-based manager or you can view the full
routing table.

When viewing the list of static routes using the CLI command get router static, it is the configured static
routes that are displayed. When viewing the routing table using the CLI command get router info
routing-table all, it is the entire routing table information that is displayed, including configured and
learned routes of all types. The two are different information in different formats.
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If VDOMs are enabled on your FortiGate unit, all routing related CLI commands must
be performed within a VDOM and not in the global context.

To view the routing table

# get router info routing-table all
Codes: K - kernel, C - connected, S - static, R - RIP, B - BGP
O - OSPF, IA - OSPF inter area
N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2
E1 - OSPF external type 1, E2 - OSPF external type 2
i - IS-IS, L1 - IS-IS level-1, L2 - IS-IS level-2, ia - IS-IS inter area
* - candidate default

S* 0.0.0.0/0 [10/0] via 192.168.183.254, port2
S 1.0.0.0/8 [10/0] via 192.168.183.254, port2
S 2.0.0.0/8 [10/0] via 192.168.183.254, port2
C 10.142.0.0/23 is directly connected, port3
B 10.160.0.0/23 [20/0] via 10.142.0.74, port3, 2d18h02m
C 192.168.182.0/23 is directly connected, port2

Examining an entry:

B 10.160.0.0/23 [20/0] via 10.142.0.74, port3, 2d18h02m

Value Description

B BGP. The routing protocol used.

10.160.0.0/23 The destination of this route, including netmask.

[20/0] 20 indicates and administrative distance of 20 out of a range of 0 to 255.

0 is an additional metric associated with this route, such as in OSPF

10.142.0.74 The gateway, or next hop.

port3 The interface used by this route.

2d18h02m How old this route is. In this case, it is almost three days old.

To view the kernel routing table

# get router info kernel

tab=254 vf=0 scope=253 type=1 proto=2 prio=0 0.0.0.0/0.0.0.0/0->10.11.201.0/24
pref=10.11.201.4 gwy=0.0.0.0 dev=5(external1)

tab=254 vf=0 scope=253 type=1 proto=2 prio=0 0.0.0.0/0.0.0.0/0->172.20.120.0/24
pref=172.20.120.146 gwy=0.0.0.0 dev=6(internal)

The parts of the routing table entry are:
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Value Description

tab Table number. This will be either 254 (unicast) or 255 (multicast).

vf Virtual domain of the firewall. This is the vdom index number. If vdoms are
not enabled, this number will be 0.

type Type of routing connection. Valid values include:

0 - unspecific
1 - unicast
2 - local
3 - broadcast
4 - anycast
5 - multicast
6 - blackhole
7 - unreachable
8 - prohibited

proto

Type of installation. This indicates where the route came from. Valid values
include:

0 - unspecific
2 - kernel
11 - ZebOS routing module
14 - FortiOS
15 - HA
16 - authentication based
17 - HA1

prio Priority of the route. Lower priorities are preferred.

->10.11.201.0/24

(->x.x.x.x/mask)
The IP address and subnet mask of the destination

pref Preferred next hop along this route

gwy Gateway - the address of the gateway this route will use

dev Outgoing interface index. This number is associated with the interface for
this route, and if VDOMs are enabled the VDOM will be included here as
well. If an interface alias is set for this interface, it will also be displayed
here.
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Searching the routing table

You can apply a filter to search the routing table and display only certain routes. For example, you can display one
or more static routes, connected routes, routes learned through RIP, OSPF, or BGP, and routes associated with
the network or gateway that you specify.

If you want to search the routing table by route type and further limit the display according to network or gateway,
all of the values that you specify as search criteria must match corresponding values in the same routing table
entry in order for that entry to be displayed. An implicit AND condition is applied to all of the search parameters
you specify.

For example, if the FortiGate unit is connected to network 172.16.14.0/24 and you want to display all directly
connected routes to network 172.16.14.0/24, you must select Connected from the Type list, type
172.16.14.0/24 in the Network field, and then select Apply Filter to display the associated routing table
entry or entries. Any entry that contains the word “Connected” in its Type field and the specified value in the
Gateway field will be displayed.

In this example, you will apply a filter to search for an entry for static route to 10.10.10.10/24.

To search the FortiGate unit routing table - web-based manager

1. Go toMonitor > Routing Monitor.
2. From the Type list, select the type of route to display. In our example, select Static.
3. If you want to display routes to a specific network, type the IP address and netmask of the network in the Networks

field. In our example, enter 10.10.10.10/24.
4. If you want to display routes to a specific gateway, type the IP address of the gateway in theGateway field.
5. Select Apply Filter.

All of the values that you specify as search criteria must match corresponding values in
the same routing table entry in order for that entry to be displayed.

To search the FortiGate unit routing table - CLI

FGT # get router info routing-table details 10.10.10.10
Routing entry for 10.10.10.10/24

Known via "static", distance 10, metric 0, best

If there are multiple routes that match your filter, they will all be listed and the best match will be at the top of the
list and indicated by the word best.

Building the routing table

In the factory default configuration, the FortiGate unit routing table contains a single static default route. You can
add routing information to the routing table by defining additional static routes.

It is possible that the routing table is faced with several different routes to the same destination—the IP
addresses of the next-hop router specified in those routes or the FortiGate interfaces associated with those
routes may vary. In this situation, the “best” route is selected from the table.

The FortiGate unit selects the “best” route for a packet by evaluating the information in the routing table. The
“best” route to a destination is typically associated with the shortest distance between the FortiGate unit and the
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closest gateway, also known as a next-hop router. In some cases, the next best route may be selected if the best
route is unavailable.

The FortiGate unit installs the best available routes in the unit’s forwarding table, which is a subset of the unit’s
routing table. Packets are forwarded according to the information in the forwarding table.

Static routing security

Securing the information on your company network is a top priority for network administrators. Security is also
required as the routing protocols used are internationally known standards that typically provide little or no
inherent security by themselves.

The two reasons for securing your network are the sensitive and proprietary information on your network, and also
your external bandwidth. Hackers can steal not only your information, but they can also steal your bandwidth.
Routing is a good low level way to secure your network, even before UTM features are applied.

Routing provides security to your network in a number of ways including obscuring internal network addresses
with NAT and blackhole routing, using RPF to validate traffic sources, and maintaining an access control list
(ACL) to limit access to the network.

Network Address Translation

Network address translation (NAT) is a method of changing the address from which traffic appears to originate.
This practice is used to hide the IP address on a company’s internal networks, and helps prevent malicious
attacks that use those specific addresses.

This is accomplished by the router connected to that local network changing all the IP addresses to its externally
connected IP address before sending the traffic out to the other networks, such as the Internet. Incoming traffic
uses the established sessions to determine which traffic goes to which internal IP address. This also has the
benefit of requiring only the router to be very secure against external attacks, instead of the whole internal
network, as would be the case without NAT. Securing the network is much cheaper and easier to maintain.

Configuring NAT on your FortiGate unit includes the following steps:

1. Configure your internal network. For example, use the 10.11.101.0 subnet.
2. Connect your internal subnet to an interface on your FortiGate unit. For example, use port1.
3. Connect your external connection (for example, an ISP gateway of 172.20.120.2) to another interface on your

Fortigate unit (for example, port2).
Configure security policies to allow traffic between port1 and port2 on your FortiGate unit, ensuring that the NAT
feature is enabled.

The above steps show that traffic from your internal network will originate on the 10.11.101.0 subnet and pass on
to the 172.20.120.0 network. The FortiGate unit moves the traffic to the proper subnet. In doing that, the traffic
appears to originate from the FortiGate unit interface on that subnet and it does not appear to originate from
where it actually came from.

NAT “hides” the internal network from the external network. This provides security through obscurity. If a hacker
tries to directly access your network, they will find the Fortigate unit, but they will not know about your internal
network. The hacker would have to get past the security-hardened FortiGate unit to gain access to your internal
network. NAT will not prevent hacking attempts that piggy back on valid connections between the internal
network and the outside world. However, other UTM security measures can deal with these attempts.

Another security aspect of NAT is that many programs and services have problems with NAT. Consider if
someone on the Internet tries to initiate a chat with someone on the internal network. The outsider can access
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only the FortiGate unit’s external interface, unless the security policy allows the traffic through to the internal
network. If allowed in, the correct internal user would respond to the chat. However, if it is not allowed, the
request to chat will be refused or it will time out. This is accomplished in the security policy by allowing or denying
different protocols.

Access control list

An access control list (ACL) is a table of addresses that have permission to send and receive data over a router’s
interface or interfaces. The router maintains an ACL, and when traffic comes in on a particular interface it is
buffered, while the router checks the ACL to see if that traffic is allowed over that port. If it is allowed on that
incoming interface, the next step is to check the ACL for the destination interface. If the traffic also passes that
check, the buffered traffic is delivered to its destination. If either of those steps fail the ACL check, the traffic is
dropped and an error message may be sent to the sender. The ACL ensures that traffic follows expected paths
and any unexpected traffic is not delivered. This stops many network attacks. However, to be effective, the ACL
must be kept up to date. When employees or computers are removed from the internal network, their IP
addresses must also be removed from the ACL. For more information about the ACL, see the router chapter of
the FortiGate CLI Reference.

Blackhole routes

A blackhole route is a route that drops all traffic sent to it. It is very much like /dev/null in Linux programming.

Blackhole routes are used to dispose of packets instead of responding to suspicious inquiries. This provides
added security since the originator will not discover any information from the target network.

Blackhole routes can also limit traffic on a subnet. If some subnet addresses are not in use, traffic to those
addresses, which may be valid or malicious, can be directed to a blackhole for added security and to reduce traffic
on the subnet.

The loopback interface, which is a virtual interface that does not forward traffic, was added to allow easier
configuration of blackhole routing. Similar to a regular interface, the loopback interface has fewer parameters to
configure and all traffic sent to it stops there. Since it cannot have hardware connection or link status problems, it
is always available, making it useful for other dynamic routing roles. Once configured, you can use a loopback
interface in security policies, routing, and other places that refer to interfaces. You configure this feature only
from the CLI. For more information, see the system chapter of the FortiGate CLI Reference.

Configuring IPv6 blackhole routes

You can configure IPv6 blackhole routes. In the FortiGate GUI, select Network > Static Routes and select
Create New. In the Interface field, choose Blackhole.
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Adding a blackhole route with a priority

You can add a priority to a blackhole route to change its position relative to kernel routes in the routing table.

To add a blackhole route with a priority, use the following CLI commands:

config router static
edit 23

set blackhole enable
set priority 200

end

IPv6 blackhole static routing

System administrators use blackhole routing to divert unwanted traffic, such as packets from a Denial of Service
(DoS) attack or communications from an illegal source. The traffic is routed to a dead interface, or a host
designed to collect information for investigation. This mitigates the impact of the attack on the network.

You can enable the use of blackhole routing, using the following CLI commands:

config router static6
edit <ID #>

set blackhole enable
end

Reverse path lookup

Whenever a packet arrives at one of the FortiGate unit’s interfaces, the unit determines whether the packet was
received on a legitimate interface by doing a reverse lookup using the source IP address in the packet header.
This is also called anti-spoofing. If the FortiGate unit cannot communicate with the computer at the source IP
address through the interface on which the packet was received, the FortiGate unit drops the packet as it is likely
a hacking attempt.

If the destination address can be matched to a local address, and the local configuration permits delivery, the
FortiGate unit delivers the packet to the local network. If the packet is destined for another network, the Fortigate
unit forwards the packet to a next-hop router according to a policy route and the information stored in the
FortiGate forwarding table.

Multipath routing and determining the best route

Multipath routing occurs when more than one entry to the same destination is present in the routing table. When
multipath routing happens, the FortiGate unit may have several possible destinations for an incoming packet,
forcing the FortiGate unit to decide which next-hop is the best one.

It should be noted that some IP addresses will be rejected by routing protocols. These are called Martian
addresses. They are typically IP addresses that are invalid and not routable because they have been assigned an
address by a misconfigured system, or are spoofed addresses.

Two methods to manually resolve multiple routes to the same destination are to lower the administrative distance
of one route or to set the priority of both routes. For the FortiGate unit to select a primary (preferred) route,
manually lower the administrative distance associated with one of the possible routes. Setting the priority on the
routes is a FortiGate unit feature and may not be supported by non-Fortinet routers.

Administrative distance is based on the expected reliability of a given route. It is determined through a
combination of the number of hops from the source and the protocol used. A hop is when traffic moves from one
router to the next. More hops from the source means more possible points of failure. The administrative distance
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can be from 1 to 255, with lower numbers being preferred. A distance of 255 is seen as infinite and will not be
installed in the routing table.

Here is an example to illustrate how administration distance works. If there are two possible routes traffic can
take between two destinations with administration distances of 5 (always up) and 31 (sometimes not available),
the traffic will use the route with an administrative distance of 5. If for some reason the preferred route (admin
distance of 5) is not available, the other route will be used as a backup.

Different routing protocols have different default administrative distances. These different administrative
distances are based on a number of factors of each protocol such as reliability, speed, and so on. The default
administrative distances for any of these routing protocols are configurable.

Default administrative distances for routing protocols and connections

Routing protocol Default administrative distance

Direct physical connection 1

Static 10

EBGP 20

OSPF 110

IS-IS 115

RIP 120

IBGP 200

Another method to determine the best route is to manually change the priority of both routes in question. If the
next-hop administrative distances of two routes on the FortiGate unit are equal, it may not be clear which route
the packet will take. Manually configuring the priority for each of those routes will make it clear which next-hop will
be used in the case of a tie. The priority for a route can be set in the CLI, or when editing a specific static route, as
described in the next section. Lower priority routes are preferred. Priority is a Fortinet value that may or may not
be present in other brands of routers.

All entries in the routing table are associated with an administrative distance. If the routing table contains several
entries that point to the same destination (the entries may have different gateways or interface associations), the
FortiGate unit compares the administrative distances of those entries first, selects the entries having the lowest
distances, and installs them as routes in the FortiGate unit forwarding table. As a result, the FortiGate unit
forwarding table contains only those routes that have the lowest distances to every possible destination. While
only static routing uses administrative distance as its routing metric, other routing protocols, such as RIP, can use
metrics that are similar to administrative distance.

Route priority

After the FortiGate unit selects static routes for the forwarding table based on their administrative distances, the
priority field of those routes determines routing preference. Priority is a Fortinet value that may or may not be
present in other brands of routers.

You can configure the priority field through the CLI or the web-based manager. Priority values can range from 0 to
4 294 967 295. The route with the lowest value in the priority field is considered the best route. It is also the
primary route.
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To change the priority of a route - web-based manager

1. Go to Network > Static Routes.
2. Select the route entry, and select Edit.
3. Select Advanced Options.
4. Enter the Priority value.
5. Select OK.

To change the priority of a route - CLI

The following command changes the priority to 5 for a route to the address 10.10.10.1 on the port1
interface.

config router static
edit 1

set device port1
set gateway 10.10.10.10
set dst 10.10.10.1
set priority 5

end

If there are other routes set to priority 10, the route set to priority 5 will be preferred. If there are routes set to
priorities less than 5, those other routes will be preferred instead.

In summary, because you can use the CLI to specify which sequence numbers or priority field settings to use
when defining static routes, you can prioritize routes to the same destination according to their priority field
settings. For a static route to be the preferred route, you must create the route using the config router
static CLI command and specify a low priority for the route. If two routes have the same administrative
distance and the same priority, then they are equal-cost multi-path (ECMP) routes.

Since this means there is more than one route to the same destination, it can be confusing which route or routes
to install and use. However, if you have enabled load balancing with ECMP routes, different sessions will resolve
this problem by using different routes to the same address.

Use of firewall addresses for static route destinations

To help prevent false positive when scanning for duplicate static routes, the dst_addr field is also checked.

Removing RPF checks from the state evaluation process

You can remove RPF (reverse path forwarding) state checks without needing to enable asymmetric routing. You
can disable state checks for traffic received on specific interfaces.

Disabling state checks makes a FortiGate unit less secure and should only be done
with caution.

To remove RPF checks from the state evaluation process, use the following CLI commands:

config system interface
edit <interface_name>

set src-check disable
end
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Troubleshooting static routing

When there are problems with your network that you believe to be related to static routing, there are a few basic
tools available to locate the problem.

These tools include:

l Ping
l Traceroute
l Examine routing table contents

Ping

Beyond the basic connectivity information, ping can tell you the amount of packet loss (if any), how long it takes
the packet to make the round trip, and the variation in that time from packet to packet.

If there is no packet loss detected, your basic network connectivity is OK.

If there is some packet loss detected, you should investigate:

l Possible ECMP, split horizon, network loops
l Cabling to ensure no loose connections

If there is total packet loss, you should investigate:

l Hardware: ensure cabling is correct, and all equipment between the two locations is accounted for
l Addresses and routes: ensure all IP addresses and routing information along the route is configured as expected
l Firewalls: ensure all firewalls are set to allow PING to pass through

To ping from a Windows PC

1. Go to a DOS prompt. Typically you go to Start > Run, enter cmd and select OK.
2. Enter ping 10.11.101.100 to ping the default internal interface of the FortiGate unit with four packets.

To ping from an Apple computer

1. Open the Terminal.
2. Enter ping 10.11.101.100.
3. If the ping fails, it will stop after a set number of attempts. If it succeeds, it will continue to ping repeatedly. Press

Control+C to end the attempt and see gathered data.

To ping from a Linux PC

1. Go to a command line prompt.
2. Enter “/bin/etc/ping 10.11.101.101”.

Traceroute

Where ping will only tell you if it reached its destination and came back successfully, traceroute will show each
step of its journey to its destination and how long each step takes. If ping finds an outage between two points,
traceroute can be used to locate exactly where the problem is.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2487



Advanced static routing

To use traceroute on a Windows PC

1. Go to a DOS prompt. Typically you go to Start > Run, enter “cmd” and select OK.
2. Enter “tracert fortinet.com” to trace the route from the PC to the Fortinet website.

To use traceroute from an Apple computer

1. Open the Terminal.
2. Enter traceroute fortinet.com.
3. The terminal will list the number of steps made. Upon reaching the destination, it will list three asterisks per line.

Press Control+C to end the attempt.

To use traceroute on a Linux PC

1. Go to a command line prompt.
2. Enter “/bin/etc/traceroute fortinet.com”.

The Linux traceroute output is very similar to the MSWindows traceroute output.

Examine routing table contents

The first place to look for information is the routing table.

The routing table is where all the currently used routes are stored for both static and dynamic protocols. If a route
is in the routing table, it saves the time and resources of a lookup. If a route is not used for a while and a new
route needs to be added, the oldest least used route is bumped if the routing table is full. This ensures the most
recently used routes stay in the table. Note that if your FortiGate unit is in Transparent mode, you will not be able
to perform this step.

If the FortiGate is running in NAT mode, verify that all desired routes are in the routing table: local subnets,
default routes, specific static routes, and dynamic routing protocols.

To check the routing table in the web-based manager, use the Routing Monitor. Go toMonitor > Routing
Monitor. In the CLI, use the command get router info routing-table all.

Static routing tips
When your network goes beyond basic static routing, here are some tips to help you plan and manage your static
routing.

Always configure a default route

The first thing you configure on a router on your network should be the default route. And where possible the
default routes should point to either one or very few gateways. This makes it easier to locate and correct
problems in the network. By comparison, if one router uses a second router as its gateway which uses a fourth for
its gateway and so on, one failure in that chain will appear as an outage for all the devices downstream. By using
one or very few addresses as gateways, if there is an outage on the network it will either be very localized or
network-wide. Either outage is easy to troubleshoot.

Have an updated network plan

A network plan lists different subnets, user groups, and different servers. Essentially, it puts all your resources on
the network and shows how the parts of your network are connected. Keeping your plan updated will also help you
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troubleshoot problemsmore quickly when they arise.

A network plan helps your static routing by eliminating potential bottlenecks and helping troubleshoot any routing
problems that come up. Also, you can use it to plan for the future and act on any changes to your needs or
resources more quickly.

Plan for expansion

No network remains the same size. At some time, all networks grow. If you take future growth into account, there
will be less disruption to your existing network when that growth happens. For example, allocating a block of
addresses for servers can easily prevent having to re-assign IP addresses to multiple servers due to a new server.

With static routing, if you group parts of your network properly you can easily use network masks to address each
part of your network separately. This will reduce the amount of administration required both to maintain the
routing and to troubleshoot any problems.

Configure as much security as possible

Securing your network through static routing methods is a good low level method to defend both your important
information and your network bandwidth.

l Implement NAT to obscure your IP address is an excellent first step
l Implement black hole routing to hide which IP addresses are in use or not on your local network
l Configure and use access control list (ACL) to help ensure you know only valid users are using the network

All three features limit access to the people who should be using your network and obscure your network
information from the outside world and potential hackers.

Policy routing
Policy routing enables you to redirect traffic away from a static route. This can be useful if you want to route
certain types of network traffic differently. You can use incoming traffic’s protocol, source address or interface,
destination address, or port number to determine where to send the traffic. For example, generally network traffic
would go to the router of a subnet, but you might want to direct SMTP or POP3 traffic directly to the mail server
on that subnet.

If you have configured the FortiGate unit with routing policies and a packet arrives at the FortiGate unit, the
FortiGate unit starts at the top of the Policy Route list and attempts to match the packet with a policy. If a match
is found and the policy contains enough information to route the packet (a minimum of the IP address of the next-
hop router and the FortiGate interface for forwarding packets to it), the FortiGate unit routes the packet using the
information in the policy. If no policy route matches the packet, the FortiGate unit routes the packet using the
routing table.

Most policy settings are optional, and a matching policy alone might not provide
enough information for forwarding the packet. In fact, the FortiGate almost always
requires a matching route in the routing table in order to use a policy route. The
FortiGate unit will refer to the routing table in an attempt to match the information in
the packet header with a route in the routing table.

Policy route options define which attributes of a incoming packet cause policy routing to occur. If the attributes of
a packet match all the specified conditions, the FortiGate unit routes the packet through the specified interface to
the specified gateway.
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To view policy routes go to Network > Policy Routes.

Field Description

Create New Add a policy route. See Adding a policy route on page 2490.

Edit Edit the selected policy route.

Delete Delete the selected policy route.

Move To
Move the selected policy route. Enter the new position and select OK.

For more information, see Moving a policy route on page 2493.

# The ID numbers of configured route policies. These numbers are
sequential unless policies have been moved within the table.

Incoming The interfaces on which packets subjected to route policies are received.

Outgoing The interfaces through which policy routed packets are routed.

Source The IP source addresses and network masks that cause policy routing to
occur.

Destination The IP destination addresses and network masks that cause policy routing
to occur.

Adding a policy route

To add a policy route, go to Network > Policy Routes and select Create New.

Field Description

Protocol Select from existing or specify the protocol number to match. The Internet
Protocol Number is found in the IP packet header. RFC 5237 describes
protocol numbers and you can find a list of the assigned protocol numbers
here. The range is from 0 to 255. A value of 0 disables the feature.

Commonly used Protocol settings include 6 for TCP sessions, 17 for UDP
sessions, 1 for ICMP sessions, 47 for GRE sessions, and 92 for multicast
sessions.

Incoming Interface Select the name of the interface through which incoming packets subjected
to the policy are received.

Source Address / Mask To perform policy routing based on IP source address, type the source
address and network mask to match. A value of 0.0.0.0/0.0.0.0
disables the feature.
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Field Description

Destination Address / Mask
To perform policy routing based on the IP destination address of the
packet, type the destination address and network mask to match. A value
of 0.0.0.0/0.0.0.0 disables the feature.

Destination Ports To perform policy routing based on the port on which the packet is
received, type the same port number in the From and To fields. To apply
policy routing to a range of ports, type the starting port number in the From
field and the ending port number in the To field. A value of 0 disables this
feature.

The Destination Ports fields are only used for TCP and UDP protocols. The
ports are skipped over for all other protocols.

Type of Service
Use a two digit hexadecimal bit pattern to match the service, or use a two
digit hexadecimal bit mask to mask out. For more information, see Type of
Service on page 2492.

Outgoing Interface Select the name of the interface through which packets affected by the
policy will be routed.

Gateway Address Type the IP address of the next-hop router that the FortiGate unit can
access through the specified interface.

Example policy route

Configure the following policy route to send all FTP traffic received at port1 out the port10 interface and to a
next hop router at IP address 172.20.120.23. To route FTP traffic, set protocol to 6 (for TCP) and set both of
the destination ports to 21 (the FTP port).

Field Value

Protocol 6

Incoming interface port1

Source address / mask 0.0.0.0/0.0.0.0

Destination address / mask 0.0.0.0/0.0.0.0

Destination Ports From 21 to 21

Type of Service bit pattern: 00 (hex) bit mask: 00 (hex)

Outgoing interface port10

Gateway Address 172.20.120.23

Enabling or disabling individual policy routes

You can enable or disable individual policy routes.
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To configure IPv4 policy routes, use the following CLI commands:

config router policy
edit 0

set status [enable|disable]
end

To configure IPv6 policy routes, use the following CLI commands:

config router policy6
edit 0

set status [enable|disable]
end

Type of Service

Type of service (TOS) is an 8-bit field in the IP header that allows you to determine how the IP datagram should
be delivered, with such qualities as delay, priority, reliability, and minimum cost.

Each quality helps gateways determine the best way to route datagrams. A router maintains a ToS value for each
route in its routing table. The lowest priority TOS is 0, the highest is 7 - when bits 3, 4, and 5 are all set to 1. The
router tries to match the TOS of the datagram to the TOS on one of the possible routes to the destination. If there
is no match, the datagram is sent over a zero TOS route.

Using increased quality may increase the cost of delivery because better performance may consume limited
network resources. For more information, see RFC 791 and RFC 1349.

The role of each bit in the IP header TOS 8-bit field

Bit Quality Description

bits 0, 1, 2 Precedence Some networks treat high precedence traffic as more important traffic.
Precedence should only be used within a network, and can be used
differently in each network. Typically you do not care about these bits.

bit 3 Delay When set to 1, this bit indicates low delay is a priority. This is useful for
such services as VoIP where delays degrade the quality of the sound.

bit 4 Throughput When set to 1, this bit indicates high throughput is a priority. This is useful
for services that require lots of bandwidth, such as video conferencing.

bit 5 Reliability When set to 1, this bit indicates high reliability is a priority. This is useful
when a service must always be available, such as with DNS servers.

bit 6 Cost When set to 1, this bit indicates low cost is a priority. Generally there is a
higher delivery cost associated with enabling bits 3, 4, or 5, and bit 6
indicates to use the lowest cost route.

bit 7 Reserved for
future use Not used at this time.

For example, if you want to assign low delay and high reliability for a VoIP application, where delays are
unacceptable, you would use a bit pattern of xxx1x1xx where ‘x’ indicates that bit can be any value. Since all bits
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are not set, this is a good use for the bit mask. If the mask is set to 0x14, it will match any TOS packets that are
set to low delay and high reliability.

Moving a policy route

A routing policy is added to the bottom of the routing table when it is created. If you prefer to use one policy over
another, you may want to move it to a different location in the routing policy table.

The option to use one of two routes happens when both routes are a match, for example
172.20.0.0/255.255.0.0 and 172.20.120.0/255.255.255.0. If both of these routes are in the
policy table, both can match a route to 172.20.120.112 but you would consider the second one a better
match. In that case, the best match route should be positioned before the other route in the policy table.

To change the position of a policy route in the table, go to Network > Policy Routes and select Move To for
the policy route you want to move.

Field Description

Before/After Select Before to place the selected policy route before the indicated route.
Select After to place it following the indicated route.

Policy route ID Enter the Policy route ID of the route in the Policy route table to move the
selected route before or after.

Use of firewall addresses for policy route destinations

When you configure a policy route, you can use firewall addresses and address groups. The only exception for
address types that can be used is the URL type of address object.

Transparent mode static routing
FortiOS operating modes allow you to change the configuration of your FortiGate unit depending on the role it
needs to fill in your network.

NAT operating mode is the standard mode, where all interfaces are accessed individually and traffic can be
routed between ports to travel from one network to another.

In transparent operating mode, all physical interfaces act like one interface. The FortiGate unit essentially
becomes a bridge. Traffic coming in over any interface is broadcast back out over all the interfaces on the
FortiGate unit.

In transparent mode, there is no entry for routing at the main level of the menu on the web-based manager
display as there is in NAT mode. Routing is instead accessed through the network menu option.

To view the routing table in transparent mode, go to Network > Routing Table.

When viewing or creating a static route entry in transparent mode, there are only three fields available.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2493



Advanced static routing

Field Description

Destination IP / Mask The destination of the traffic being routed. The first entry is attempted first
for a match, then the next, and so on until a match is found or the last entry
is reached. If no match is found, the traffic will not be routed.

Use 0.0.0.0 to match all traffic destinations. This is the default route.

Gateway Specifies the next hop for the traffic. Generally the gateway is the address
of a router on the edge of your network.

Priority The priority is used if there is more than one match for a route. This allows
multiple routes to be used, with one preferred. If the preferred route is
unavailable, the other routes can be used instead.

Valid range of priority can be from 0 to 4 294 967 295.

If more than one route matches and they have the same priority, it
becomes an ECMP situation and traffic is shared among those routes. See
Transparent mode static routing on page 2493.

When configuring routing on a FortiGate unit in transparent mode, remember that all interfaces must be
connected to the same subnet. That means all traffic will be coming from and leaving on the same subnet. This is
important because it limits your static routing options to only the gateways attached to this subnet. For example,
if you only have one router connecting your network to the Internet, all static routing on the FortiGate unit will use
that gateway. For this reason, static routing on FortiGate units in transparent mode may be a bit different, but it is
not as complex as routing in NAT mode.

Static routing example
This is an example of a typical small network configuration that uses only static routing.

This network is in a dental office that includes a number of dentists, assistants, and office staff. The size of the
office is not expected to grow significantly in the near future, and the network usage is very stable (there are no
new applications being added to the network).

The users on the network are:

l Administrative staff: access to local patient records, and perform online billing
l Dentists: access and update local patient records, research online from desk
l Assistants: access and update local patient records in exam rooms

The distinction here is mainly that only the administrative staff and dental office need access to the Internet. All
the other traffic is local and does not need to leave the local network. Routing is only required for the outbound
traffic, and the computers that have valid outbound traffic.

Configuring routing only on computers that need it, acts as an additional layer of
security by helping prevent malicious traffic from leaving the network.
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Network layout and assumptions

The computers on the network are administrative staff computers, dental office computers, and dental exam
room computers. While there are other devices on the local network, such as printers, they do not need Internet
access or any routing.

This networked office equipment includes 1 administrative staff PC, 3 dentist's PCs, and 5 exam room PCs.
There is also a network printer and a router on the network.

Assumptions about these computers and network include:

l The FortiGate unit is a model with interfaces labeled port1 and port2.
l The FortiGate unit has been installed and is configured in NAT mode.
l VDOMs are not enabled.
l The computers on the network are running MSWindows software.
l Any hubs required in the network are not shown in the network diagram.
l The network administrator has access to the ISP IP addresses and is the super_admin administrator on the

FortiGate unit.

Static routing example device names, IP addresses, and level of access

Device name IP address Need external access?

Router 192.168.10.1 YES

Admin 192.168.10.11 YES

Dentist1-3 192.168.10.21-23 YES

Exam1-5 192.168.10.31-35 NO

Printer 192.168.10.41 NO

General configuration steps

The steps to configuring routing on this network are:

1. Get your ISP information such as DNS, gateway, etc.
2. Configure FortiGate unit
3. Configure administrator PC and dentists' PCs
4. Testing network configuration

Get your ISP information such as DNS, gateway, etc.

Your local network connects to the Internet through your Internet Service Provider (ISP). They have IP addresses
that you need to configure your network and routing.

The addresses needed for routing are your assigned IP address, DNS servers, and the gateway.
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Configure FortiGate unit

The FortiGate unit will have two interfaces in use: one connected to the internal network, and one connected to
the external network. Port1 will be the internal interface and port2 will be the external interface.

To configure the FortiGate unit:

1. Configure the internal interface (port1)
2. Configure the external interface (port2)
3. Configure networking information
4. Configure basic security policies
5. Configure static routing

Configure the internal interface (port1)

To configure the internal interface (port1) - web based manager

1. Go to Network > Interfaces. Highlight port1 and select Edit.
2. Enter the following:

Addressing Mode Manual

IP/Netmask 172.100.1.1/255.255.255.0

Administrative Access HTTPS, PING, TELNET

Description Internal network

To configure the internal interface (port1) - CLI

config system interface
edit port1

set IP 192.168.10.1 255.255.255.0
set allowaccess https ping telnet
set description “internal network”

end
end

Configure the external interface (port2)

The external interface connects to your ISP’s network. You need to know the IP addresses in their network that
you should connect to. In this example, the address that the ISP gave you is 172.100.20.20, which will connect to
the gateway at 172.100.20.5 on their network, and their DNS servers are 172.11.22.33 and 172.11.22.34.

To configure the internal interface (port2) - web based manager

1. Go to Network > Interfaces. Highlight port2 and select Edit.
2. Enter the following:

Addressing Mode Manual
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IP/Netmask 172.100.20.20/255.255.255.0

Administrative Access HTTPS, PING, TELNET

Description Internal network

To configure the internal interface (port2) - CLI

configure system interface
edit port2

set IP 172.100.20.20 255.255.255.0
set allowaccess https ping telnet
set description “internal network”

end
end

Configure networking information

Networking information includes the gateway and DNS servers. Your FortiGate unit requires a connection to the
Internet for antivirus and other periodic updates.

To configure networking information - web-based manager

1. Go to Network > DNS.
2. Enter the primary and secondary DNS addresses.
3. Select Apply.

To configure networking information - CLI

config system global
set dns_1 172.11.22.33
set dns_2 172.11.22.34

end

Configure basic security policies

For traffic to flow between the internal and external ports in both directions, as a minimum, two security policies
are required. More can be used to further limit or direct traffic, as needed, but will not be included here.

Before configuring the security policies, a firewall address group is configured for the PCs that are allowed
Internet access. This prevents a PC without Internet privileges from accessing the Internet.

The security policy assumptions are:

l Only the basic networking services have been listed as allowed, for added security. Others can easily be added as
the users require them.

l In this example, to keep things simple, both incoming and outgoing security policies are the same. In a real network
there are applications that are allowed out but not in, and vice versa.

l Endpoint control has been enabled to ensure that all computers on the local network are running FortiClient and
those installs are up to date. This feature ensures added security on your local network without the need for the
network administrator to continually bother users to update their software. The FortiGate unit can store an up to
date copy of the FortiClient software and offer a URL to it for users to install it if they need to.
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To configure security policies - web-based manager

1. Go to Policy & Objects > Objects > Addresses.
2. Create a new Firewall Address entry for each of:

PC Name IP Address Interface

Admin 192.168.10.11 port1

Dentist1 192.168.10.21 port1

Dentist2 192.168.10.22 port1

Dentist3 192.168.10.23 port1

3. Go to Policy & Objects > Objects > Addresses.
4. Select the dropdown arrow next to Create New and select Address Group.
5. Name the group Internet_PCs.
6. Add Admin, Dentist1, Dentist2, and Dentist3 as members of the group.
7. Select OK.
8. Go to Policy & Objects > Policy > IPv4.
9. Select Create New.
10. Enter the following: DH - port2(external) -> port1(internal)

Incoming Interface port2

Source Address all

Outgoing Interface port1

Destination Address Internet_PCs

Schedule always

Service
Multiple.

Select DHCP, DNS,FTP, HTTP, HTTPS, NTP, POP3, SMTP, SSH.

Action ACCEPT

Log Allowed Traffic Enabled

11. Select OK.
12. Select Create New.
13. Enter the following:

Incoming Interface port1

Source Address Internet_PCs
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Outgoing Interface port2

Destination Address all

Schedule always

Service
Multiple.

Select DHCP, DNS,FTP, HTTP, HTTPS, NTP, POP3, SMTP, SSH.

Action ACCEPT

Log Allowed Traffic Enabled

14. Select OK.

To configure security policies - CLI

config firewall address
edit "Admin"

set associated-interface "port1"
set subnet 192.168.10.11 255.255.255.255

next
edit "Dentist1"

set associated-interface "port1"
set subnet 192.168.10.21 255.255.255.255

next
edit "Dentist2"

set associated-interface "port1"
set subnet 192.168.10.22 255.255.255.255

next
edit "Dentist3"

set associated-interface "port1"
set subnet 192.168.10.23 255.255.255.255

end
config firewall addrgrp

edit Internet_PCs
set member Admin Dentist1 Dentist2 Dentist3

end
config firewall policy

edit 1
set srcintf port1
set dstintf port2
set srcaddr Internet_PCs
set dstaddr all
set action accept
set schedule always
set service "DHCP" "DNS" "FTP" "HTTP" "HTTPS" "NTP" "POP3" "SMTP" "SSH"
set logtraffic enable
set label "Section2"
set endpoint-restrict-check no-av db-outdated

next
edit 2

set srcintf port2
set dstintf port1
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set srcaddr all
set dstaddr Internet_PCs
set action accept
set schedule always
set service "DHCP" "DNS" "FTP" "HTTP" "HTTPS" "NTP" "POP3" "SMTP" "SSH"
set logtraffic enable
set label "Section2"
set endpoint-restrict-check no-av db-outdated

end
end

Adding FortiClient enforcement to interfaces

You can enforce the use of FortiClient on individual interfaces.

In the FortiGate GUI, select Network > Interfaces and choose an interface. Under the Admission Control
heading, you can enable the Allow FortiClient Connections setting. Once you enable this setting, two more
options become visible: Discover Clients (Broadcast) and FortiClient Enforcement. When you enable
FortiClient enforcement, you enforce that in order for incoming traffic to pass through that interface, it must be
initiated by a device running FortiClient.

Once you enforce the use of FortiClient on the interface, you should also configure FortiClient profiles for the
incoming connections. You can also set up any exemptions that are needed. Just below the FortiClient
Enforcement option are fields for Exempt Sources and Exempt Destinations/Services. These can be
selected from address or services objects already configured on the FortiGate.

In the CLI, use the following commands:

config system interface
edit port1

set listen-forticlient-connection [enable|disable]
set endpoint-compliance [enable|disable]
end

Configure static routing

With the rest of the FortiGate unit configured, static routing is the last step before moving on to the rest of the
local network. All traffic on the local network will be routed according to this static routing entry.

To configure Fortinet unit static routing - web-based manager

1. Go to Network > Static Routes.
2. Select the top route on the page and then select Edit.
3. Enter the following information:

Destination IP/Mask 172.100.20.5

Gateway 172.100.20.5

Interface port2

Administrative Distance 10

4. Select OK.
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To configure Fortinet unit static routing - CLI

configure routing static
edit 1

set gateway 172.100.20.5
set distance 10
set device port2
set dst 0.0.0.0

end
end

Configure administrator PC and dentists' PCs

After the router is configured, we need to configure the computers that require Internet access. These computers
need routing to be configured on them. As the other computers do not require routing, they are not included here.

The procedure to configure these computers is the same. Repeat the following procedure for the corresponding
PCs.

The Windows CLI procedure does not configure the DNS entries. It just adds the static
routes.

To configure routing and DNS on administrator and dentists' PCs - Windows GUI

1. On the PC, select Start > Control Panel > Network Connections.
2. Right click on the network connection to your local network that has a status of Connected, and select Properties.
3. Under theGeneral tab, from the list select TCP/IP, and Properties.
4. UnderGateway, enter the FortiGate unit address (192.168.10.1).
5. Enter the primary and secondary DNS server addresses from your ISP (172.11.22.33 and 172.11.22.34).
6. Select OK.

To configure routing on administrator and dentists' PCs - Windows CLI

1. On the PC, select Start > Run, enter “cmd”, and select OK.
2. At the command prompt, type:

route ADD 0.0.0.0 MASK 0.0.0.0 172.100.20.5 METRIC 10
route ADD 192.168.10.0 MASK 255.255.255.0 192.168.10.1 METRIC 5

3. Confirm these routes have been added. Type:
route PRINT

If you do not see the two routes you added, try adding them again, while paying attention to avoid
spelling mistakes.

4. Test that you can communicate with other computers on the local network, and with the Internet. If there are no
other computers on the local network, connect to the FortiGate unit.

Configure other PCs on the local network

The PCs on the local network without Internet access (for example, the exam room PCs) can be configured now.

As this step does not require any routing, details have not been included.
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Testing network configuration

There are three tests to run on the network to ensure proper connectivity:

l To test that PCs on the local network can communicate
l Test that Internet_PCs on the local network can access the Internet
l Test that non-Internet_PCs cannot access the Internet

Test that PCs on the local network can communicate

1. Select any two PCs on the local network, such as Exam4 and Dentist3.
2. On the Exam4 PC, at the command prompt, enter ping 192.168.10.23.

The output from this command should appear similar to the following:

Pinging 192.168.10.23 with 32 bytes of data:

Reply from 192.168.10.23: bytes=32 time<1m TTL=255
Reply from 192.168.10.23: bytes=32 time<1m TTL=255
Reply from 192.168.10.23: bytes=32 time<1m TTL=255

3. At the command prompt, enter exit to close the window.
4. On the Dentist3 PC, at the command prompt, enter ping 192.168.10.34.

The output from this command should appear similar to the following:

Pinging 192.168.10.34 with 32 bytes of data:

Reply from 192.168.10.34: bytes=32 time<1m TTL=255
Reply from 192.168.10.34: bytes=32 time<1m TTL=255
Reply from 192.168.10.34: bytes=32 time<1m TTL=255

5. At the command prompt, enter exit to close the window.
6. Repeat these steps for all PCs on the local network.

If the output does not appear similar to above, there is a problem with the network configuration
between these two PCs.

To test that Internet_PCs on the local network can access the Internet

The easiest way to access the Internet is with an Internet browser. However, if that does not work, it is best to do
a traceroute to see at what point the problem is. This can help determine if it is a networking problem such as
cabling, or if it is an access problem, such as this PC not having Internet access.

1. Select any PC on the local network that is supposed to have Internet access, such as Admin.
2. On the Admin PC, open an Internet browser and attempt to access a website on the Internet, such as

http://www.fortinet.com.
If this is successful, this PC has Internet access.

3. If step2 was not successful, at the command prompt on the PC, enter traceroute 22.11.22.33.
The output from this command should appear similar to:

Pinging 22.11.22.33 with 32 bytes of data:

Reply from 22.11.22.33: bytes=32 time<1m TTL=255
Reply from 22.11.22.33: bytes=32 time<1m TTL=255
Reply from 22.11.22.33: bytes=32 time<1m TTL=255
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Dynamic routing overview

This section provides an overview of dynamic routing and how it compares to static routing.

What is dynamic routing?
Dynamic routing uses a dynamic routing protocol to automatically select the best route to put into the routing
table. Instead of having to manually enter static routes in the routing table, dynamic routing automatically
receives routing updates and dynamically decides which routes are best to go into the routing table. It is this
intelligent and hands-off approach that makes dynamic routing so useful.

Dynamic routing protocols vary in many ways and this is reflected in the various administrative distances assigned
to routes learned from dynamic routing. These variations take into account differences in reliability, speed of
convergence, and other similar factors. For more information about these administrative distances, see
Advanced static routing on page 2473.

Comparing static and dynamic routing

A common term used to describe dynamic routing is convergence. Convergence is the ability to work around
network problems and outages, for the routing to come together despite obstacles. For example, if the main
router between two end points goes down, convergence is the ability to find a way around that failed router and
reach the destination. Static routing has zero convergence beyond trying the next route in its limited local routing
table. If a network administrator does not fix a routing problem manually, it may never be fixed and may result in
a downed network. Dynamic routing solves this problem by involving routers along the route in the decision-
making process about the optimal route, and using the routing tables of these routers to find potential routes
around the outage. In general, dynamic routing has better scalability, robustness, and convergence. However,
the cost of these added benefits includes more complexity and some overhead. For example, the routing protocol
uses some bandwidth for its own administration.

Comparing static and dynamic routing

Feature Static routing Dynamic routing

Hardware
support

Supported by all routing hardware May require special, more expensive routers

Router memory
required Minimal Can require considerable memory for larger

tables

Complexity Simple Complex

Overhead None Varying amounts of bandwidth used for routing
protocol updates

Scalability Limited to small networks Very scalable, better for larger networks
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Feature Static routing Dynamic routing

Robustness None: if a route fails, it has to be
fixed manually

Robust: traffic routed around failures
automatically

Convergence None Varies from good to excellent

Dynamic routing protocols

A dynamic routing protocol is an agreed-on method of routing that the sender, receiver, and all routers along the
path (route), support. Typically, the routing protocol involves a process running on all computers and routers
along that route to enable each router to handle routes in the same way as the others. The routing protocol
determines how the routing tables are populated along that route, how the data is formatted for transmission,
and what information about a route is included with that route. For example, RIP and BGP use distance vector
algorithms and OSPF uses a shortest path first algorithm. Each routing protocol has different strengths and
weaknesses. One protocol may have fast convergence, while another may be very reliable, and a third may be
very popular for certain businesses like Internet Service Providers (ISPs).

Dynamic routing protocols are different from each other in a number of ways, such as:

l Classful versus classless routing protocols
l Interior versus exterior routing protocols
l Distance vector versus link-state protocols

Classful versus classless routing protocols

Classful and classless routing refers to how the routing protocol handles the IP addresses. In classful addresses,
there is the specific address and the host address of the server that address is connected to. Classless addresses
use a combination of IP address and netmask.

Classless Inter-Domain Routing (CIDR) was introduced in 1993 (originally with RFC 1519 and most recently with
RFC 4632) to keep routing tables from getting too large. With classful routing, each IP address requires its own
entry in the routing table. With classless routing, a series of addresses can be combined into one entry,
potentially saving vast amounts of space in routing tables.

Current routing protocols that support classless routing, out of necessity, include RIPv2, BGP, IS-IS, and OSPF.
Older protocols, such as RIPv1, do not support CIDR addresses.

Interior versus exterior routing protocols

The names interior and exterior and are very descriptive. Interior routing protocols are designed for use within a
contained network of limited size, whereas exterior routing protocols are designed to link multiple networks
together. They can be used in combination in order to simplify network administration. For example, a network
can be built with only border routers of a network running the exterior routing protocol, while all the routers on the
network run the interior protocol. This prevents them from connecting outside the network without passing
through the border. Exterior routers in such a configuration must have both exterior and interior protocols to
communicate with the interior routers and outside the network.

Nearly all routing protocols are interior routing protocols. Only BGP is commonly used as an exterior routing
protocol.

You may see interior gateway protocol (IGP) used to refer to interior routing protocols, and exterior gateway
protocol (EGP) used to refer to interior routing protocols.
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Distance vector versus link-state protocols

Every routing protocol determines the best route between two addresses using a different method. However,
there are two main algorithms for determining the best route: distance vector and link-state.

Distance vector protocols

In distance vector protocols, routers are told about remote networks through neighboring routers. The distance
part refers to the number of hops to the destination and, in more advanced routing protocols, these hops can be
weighted by factors such as available bandwidth and delay. The vector part determines which router is the next
step along the path for this route. This information is passed along from neighboring routers with routing update
packets that keep the routing tables up to date. Using this method, an outage along a route is reported back
along to the start of that route, ideally before the outage is encountered.

On distance vector protocols, RFC 1058, which defines RIP v1, states the following:

Distance vector algorithms are based on the exchange of only a small amount of information. Each
entity (gateway or host) that participates in the routing protocol is assumed to keep information
about all of the destinations within the system. Generally, information about all entities connected
to one network is summarized by a single entry, which describes the route to all destinations on
that network.

There are four main weaknesses inherent in the distance vector method. Firstly, the routing information is not
discovered by the router itself, but is instead reported information that must be relied on to be accurate and up-to-
date. The second weakness is that it can take a while for the information to make its way to all the routers who
need the information; in other words, it can have slow convergence. The third weakness is the amount of
overhead involved in passing these updates all the time. The number of updates between routers in a larger
network can significantly reduce the available bandwidth. The fourth weakness is that distance vector protocols
can end up with routing-loops. Routing loops are when packets are routed forever around a network, and often
occur with slow convergence. The bandwidth required by these infinite loops will slow your network to a halt.
There are methods of preventing these loops, however, so this weakness is not as serious as it may first appear.

Link-state protocols

Link-state protocols are also known as shortest path first protocols. Where distance vector uses information
passed along that may or may not be current and accurate, in link-state protocols each router passes along
information only about the networks and devices that are directly connected to it. This results in a more accurate
picture of the network topology around your router, allowing it to make better routing decisions. This information
is passed between routers using link-state advertisements (LSAs). To reduce the overhead, LSAs are only sent
out when information changes, compared to distance vector sending updates at regular intervals even if no
information has changed. The more accurate network picture in link-state protocols greatly speed up convergence
and avoid problems such as routing-loops.

Minimum configuration for dynamic routing

Dynamic routing protocols do not pay attention to routing updates from other sources, unless you specifically
configure them to do so using CLI redistribute commands within each routing protocol.

The minimum configuration for any dynamic routing to function is to have dynamic routing configured on one
interface on the FortiGate unit, and one other router configured as well. Some protocols require larger networks
to function as designed.
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Minimum configuration based on dynamic protocol

BGP RIP OSPF / IS-IS

Interface Yes Yes Yes

Network Yes Yes Yes

AS Local and neighbor No Yes

Neighbors At least one At least one At least one

Version No Yes No

Router ID No No Yes

Comparison of dynamic routing protocols
Each dynamic routing protocol was designed to meet a specific routing need. Each protocol does some things
well, and other things not so well. For this reason, choosing the right dynamic routing protocol for your situation is
not an easy task.

Features of dynamic routing protocols

Each protocol is better suited for some situations over others.

Choosing the best dynamic routing protocol depends on the size of your network, speed of convergence required,
the level of network maintenance resources available, what protocols the networks you connect to are using, and
so on. For more information about these dynamic routing protocols, see RIP on page 2519, BGP on page 2598,
OSPF on page 2557, and IS-IS on page 2637.

Comparing RIP, BGP, and OSPF dynamic routing protocols

Protocol RIP BGP OSPF / IS-IS

Routing algorithm Distance vector, basic Distance vector,
advanced

Link-state

Common uses Small, non-complex
networks

Network backbone, ties
multinational offices
together

Common in large,
complex enterprise
networks
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Protocol RIP BGP OSPF / IS-IS

Strengths Fast and simple to
implement

Near universal support

Good when no
redundant paths

Graceful restart

BFD support

Only needed on border
routers

Summarize routes

Fast convergence

Robust

Little management
overhead

No hop count limitation

Scalable

Weakness

Frequent updates can
flood network

Slow convergence

Maximum 15 hops may
limit network
configuration

Required full mesh in
large networks can cause
floods

Route flap

Load-balance multi-
homed networks

Not available on low-end
routers

Complex

No support for unequal
cost multipath routing

Route summary can
require network changes

Authentication Optional authentication using text string or MD5 password.

(RIP v1 has no authentication)

IPv6 support Only in RIPng Only in BGP4+ Only in OSPF6 /
Integrated IS-IS

Routing protocols

l Routing Information Protocol (RIP) uses classful routing, as well as incorporating various methods to stop
incorrect route information from propagating, such as the poisoned horizon method. However, on larger networks
its frequent updates can flood the network and its slow convergence can be a problem.

l Border Gateway Protocol (BGP) has been the core Internet backbone routing protocol since the mid-1990s, and
is the most used interior gateway protocol (IGP). However, some configurations require full mesh connections
which flood the network, and there can be route flap and load balancing issues for multihomed networks.

l Open Shortest Path First (OSPF) is commonly used in large enterprise networks. It is the protocol of choice,
mainly due to its fast convergence. However, it can be complicated to setup properly.

l Intermediate System to Intermediate System (IS-IS) Protocol allows routing of ISO’s OSI protocol stack
Connectionless Network Service (CLNS). IS-IS is an Interior Gateway Protocol (IGP) not intended to be used
between Autonomous Systems (ASes). IS-IS is a link state protocol well-suited to smaller networks that is in
widespread use and has near universal support on routing hardware.

l Multicast addressing is used to broadcast from one source to many destinations efficiently. Protocol Independent
Multicast (PIM) is the protocol commonly used in enterprises, multimedia content delivery, and stock exchanges.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2507



Dynamic routing overview

Routing algorithm

Each protocol uses a slightly different algorithm for choosing the best route between two addresses on the
network. The algorithm is the “intelligent” part of a dynamic protocol because the algorithm is responsible for
deciding which route is best and should be added to the local routing table. RIP and BGP use distance vector
algorithms, where OSPF and IS-IS use link-state or a shortest path first algorithm.

Vector algorithms are essentially based on the number of hops between the originator and the destination in a
route, possibly weighting hops based on how reliable, fast, and error-free they are.

The link-state algorithm used by OSPF and IS-IS is called the Dijkstra algorithm. Link-state treats each interface
as a link and records information about the state of the interface. The Dijkstra algorithm creates trees to find the
shortest paths to the routes it needs based on the total cost of the parts of the routes in the tree.

For more information about the routing algorithm used, see Comparison of dynamic routing protocols on page
2506.

Authentication

If an attacker gains access to your network, they can masquerade as a router on your network to either gain
information about your network or disrupt network traffic. If you have a high quality firewall configured, it will help
your network security and stop many of these types of threats. However, the main method for protecting your
routing information is to use authentication in your routing protocol. Using authentication on your FortiGate unit
and other routers prevents access by attackers because all routers must authenticate with passwords, such as
MD5 hash passwords, to ensure they are legitimate routers.

When you configure authentication on your network, ensure that you configure it the same way on all devices on
the network. Failure to do so will create errors and outages as those forgotten devices fail to connect to the rest of
the network.

For example, to configure an MD5 key of 123 on an OSPF interface called ospf_test, enter the following CLI
commands:

config router ospf
config ospf-interface

edit ospf_test
set authentication md5
set md5-key 123

end
end

Convergence

Convergence is the ability of a networking protocol to re-route around network outages. Static routing cannot do
this. Dynamic routing protocols can all converge, but take various amounts of time to do this. Slow convergence
can cause problems, such as network loops, which degrade network performance.

You may also hear robustness and redundancy used to describe networking protocols. In many ways, they are the
same thing as convergence. Robustness is the ability to keep working even though there are problems, including
configuration problems as well as network outages. Redundancy involves having duplicate parts that can
continue to function in the event of some malfunction, error, or outage. It is relatively easy to configure dynamic
routing protocols to have backup routers and configurations that will continue to function no matter the network
problem, short of a total network failure.
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IPv6 support

IPv4 addressing is in common use everywhere around the world. IPv6 has much larger addresses and it is used by
many large companies and government departments. IPv6 is not as common as IPv4 yet, but more companies
are adopting it.

If your network uses IPv6, your dynamic routing protocol must support it. None of the dynamic routing protocols
supported IPv6 originally, but they all have additions, expansions, or new versions that now support IPv6. For
more information, see RIP on page 2519, BGP on page 2598, OSPF on page 2557, or IS-IS on page 2637.

When to adopt dynamic routing

Static routing is more than enough to meet your networking needs when you have a small network. However, as
your network grows, the question you need to answer is at what point do you adopt dynamic routing in your
networking plan and start using it in your network? The main factors in this decision are typically:

l Budget
l Current network size and topology
l Expected network growth
l Available resources for ongoing maintenance

Budget

When making any business decision, you must always consider your budget. Static routing does not involve
special hardware, fancy software, or expensive training courses.

Dynamic routing can include all of these extra expenses. Any new hardware, such as routers and switches, will
need to support the routing protocols that you choose. Network management software and routing protocol
drivers may also be necessary to help configure and maintain your more complex network. If the network
administrators are not well versed in dynamic routing, you must budget either a training course or some hands-on
learning time so they can administer the new network with confidence. Together, these factors can impact your
budget.

Additionally, people will always account for network starting costs in the budgets but usually leave out the
ongoing cost of network maintenance. Any budget must provide for the hours that will be spent on updating the
network routing equipment and fixing any problems. Without that money in the budget, you may end up back at
static routing before you know it.

Current network size and topology

As stated earlier, static routing works well on small networks. As those networks get larger, routing takes longer,
routing tables get very large, and general performance is not what it could be.

Topology is a concern as well. If all your computers are in one building, it is much easier to stay with static routing
longer. However, connecting a number of locations will be easier with the move to dynamic routing.

If you have a network of 20 computers, you can still likely use static routing. If those computers are in two or three
locations, static routing will still be a good choice for connecting them. Also, if you just connect to your ISP and do
not worry about any special routing to do that, you are likely safe with just static routing.

If you have a network of 100 computers in one location, you can use static routing but it will be slower, more
complex, and there will not be much room for expansion. If those 100 computers are spread across three or more
locations, dynamic routing is the way to go.

If you have 1000 computers, you definitely need to use dynamic routing no matter how many locations you have.
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Hopefully this section has given you an idea of what results you will likely experience from different sized
networks using different routing protocols. Your choice of which dynamic routing protocol to use is partly
determined by the network size and topology.

Expected network growth

You may not be sure if your current network is ready for dynamic routing. However, if you are expecting rapid
growth in the near future, it is a good idea to start planning for that growth now so you are ready for the coming
expansion.

Static routing is very labor intensive. Each network device’s routing table needs to be configured and maintained
manually. If there is a large number of new computers being added to the network, they each need to have the
static routing table configured and maintained. If devices are being moved around the network frequently, they
must also be updated each time.

Instead, consider putting dynamic routing in place before the new computers are installed on the network. The
installation issues can be worked out with a smaller and less complex network, and when the new computers or
routers are added to the network there will be nowhere near the level of manual configuration required.
Depending on the level of growth, the labor savings can be significant. For example, in an emergency you can
drop a new router into a network or AS, wait for it to receive the routing updates from its neighbors, and then
remove one of the neighbors. While the routes will not be the most effective possible, this method is much less
work than static routing in the same situation, with less chance of mistakes.

Also, as your network grows and you add more routers, the new routers can help share the load in most dynamic
routing configurations. For example, if you have 4 OSPF routers and 20,000 external routes, those few routers
will be overwhelmed. But a network with 15 OSPF routers will be better able to handle that number of routes.
However, be aware that adding more routers to your network will increase the amount of updates sent between
the routers, which will use up a greater part of your bandwidth and use more bandwidth overall.

Available resources for ongoing maintenance

As explained in the budget section, there must be resources dedicated to ongoing network maintenance,
upgrades, and troubleshooting. These resources include administrator hours to configure and maintain the
network, training for the administrator (if needed), extra hardware and software as needed, and possible extra
staff to help the administrator in emergencies. Without these resources, you will quickly find the network reverting
to static routing out of necessity. This is because:

l Routing software updates will require time
l Routing hardware updates will require time
l Office reorganizations or significant personnel movement will require time from a networking point of view
l Networking problems that occur, such as failed hardware, require time to locate and fix the problem

If resources to accomplish these tasks are not budgeted, the tasks will either not happen at the required level to
continue operation or not happen at all. This will result in both the network administration staff and the network
users being very frustrated.

A lack of a maintenance budget will also result in an increasingly heavy reliance on static routing as the network
administrators are forced to use quick fixes for problems that come up. This invariably involves going to static
routing, and dropping the more complex and time-consuming dynamic routing.
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Choosing a routing protocol
One of that hardest decisions in routing can be choosing which routing protocol to use on your network. It can be
easy to decide when static routing will not meet your needs, but how can you tell which dynamic routing protocol
is best for your network and situation?

Here is a brief look at the routing protocols, including their strongest and weakest points. The steps to choosing
your routing protocol are:

1. Answer questions about your network
2. Evaluate your chosen protocol
3. Implement your dynamic routing protocol

Answer questions about your network

Before you can decide what is best for your situation, you need to examine the details of your situation, such as
what you have for budget, equipment, and users.

The following questions will help you form a clear idea of your routing needs:

How many computers or devices are on your network?

The number of computers or devices that you have on your network, and whether the devices are all in one
location or distributed, matters. All routing protocols can be run on networks of any size, but it can be inefficient to
run some routing protocols on very small networks. Also, routers and network hardware that support dynamic
routing can be more expensive than more generic routers for static routing.

What applications typically run over the network?

Finding out what applications your users are running will help you determine their needs and the needs of the
network regarding bandwidth, quality of service, and other such issues.

What level of service do the users expect from the network?

Different users have different expectations of the network. It's not critical for someone surfing the Internet to have
100% uptime, but it is required for a stock exchange network or a hospital.

Is there network expansion in your near future?

You may have a small network now, but if it will be growing quickly, you should plan for the expected size so you
do not have to change technologies again down the road.

What routing protocols do your networks connect to?

This is most often how routing protocol decisions are made. You need to be able to communicate easily with your
service provider and neighbors, so often people simply use what everyone else is using.

Is security a major concern?

Some routing protocols have levels of authentication and other security features built in, and others do not. If
security is important to you, be aware of this.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2511



Dynamic routing overview

What is your budget?

You need to know what both your initial and maintenance budget is. More robust and feature laden routing
protocols generally mean more resources are required to keep them working well. Also, more secure
configurations require still more resources. This includes both set up costs and ongoing maintenance costs. If you
ignore these costs, you risk having to drop the adoption of the new routing protocol mid-change.

Evaluate your chosen protocol

Once you have examined the features of the routing protocols listed above and chosen the one that best meets
your needs, you can set up an evaluation or test installation of that protocol.

The test installation is generally set up in a sandbox configuration so it will not affect critical network traffic. The
aim of the test installation is to prove that it will work on a larger scale on your network. You must ensure that the
test installation mirrors your larger network well enough for you to discover any problems. If the test installation is
too simpe, these problemsmay not appear.

If your chosen protocol does not meet your goals, choose a different protocol and repeat the evaluation process
until a protocol meets your needs or you change your criteria.

Implement your dynamic routing protocol

You have examined your needs, selected the best matching dynamic routing protocol, tested it, and now you are
ready to implement it with confidence.

This guide will help you configure your FortiGate unit to support your chosen dynamic routing protocol. Refer to
the various sections in this guide, as needed, during your implementation to help ensure a smooth transition.
Examples for each protocol are included to show proper configurations for different types of networks.

Dynamic routing terminology
Dynamic routing is a complex subject. There are many routers on different networks and all can be configured
differently. It is more complicated by the fact that each routing protocol has different names for similar features,
as well as many features that you can configure for each protocol.

To better understand dynamic routing, the following sections provide explanations on common dynamic routing
terms

For more details about a term, as it applies to a dynamic routing protocol, see BGP on page 2598, RIP on page
2519, or OSPF on page 2557.

Aggregated routes and addresses

Just as an aggregate interface combines multiple interfaces into one virtual interface, an aggregate route
combines multiple routes into one route. This reduces the amount of space those routes require in the routing
tables of the routers along that route. The trade-off is a small amount of processing to aggregate and de-
aggregate the routes at either end.

The benefit of this method is that you can combine many addresses into one, potentially reducing the routing
table size immensely. The weakness of this method is if there are holes in the address range you are
aggregating, you need to decide if it is better to break it into multiple ranges, or accept the possibility of failed
routes to the missing addresses.

For information about aggregated routes in BGP, see BGP on page 2598.
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To manually aggregate the range of IP addresses from 192.168.1.100 to 192.168.1.103

1. Convert the addresses to binary:
192.168.1.100 = 11000000 10101000 00000001 01100100
192.168.1.101 = 11000000 10101000 00000001 01100101
192.168.1.102 = 11000000 10101000 00000001 01100110
192.168.1.103 = 11000000 10101000 00000001 01100111

2. Determine the maximum number of matching bits common to the addresses.
There are 30-bits in common, with only the last 2-bits being different.

3. Record the common part of the address:
11000000 10101000 00000001 0110010X = 192.168.1.100

4. For the netmask, assume all the bits in the netmask are 1, except those that are different (which are 0):
11111111 11111111 11111111 11111100 = 255.255.255.252

5. Combine the common address bits and the netmask:
192.168.1.100/255.255.255.252

Alternately, the IPmask may be written as a single number:

192.168.1.100/2

6. As required, set variables and attributes to declare that the routes have been aggregated, and which router did the
aggregating.

Autonomous system

An Autonomous System (AS) is one or more connected networks that use the same routing protocol, and appear
to be a single unit to any externally connected networks. For example, an ISPmay have a number of customer
networks connected to it, but to any networks connected externally to the ISP, it appears as one system or AS. An
ASmay also be referred to as a routing domain.

It should be noted that while OSPF routing takes place within one AS, the only part of OSPF that deals with the
AS is the AS border router (ASBR).

There are multiple types of ASs, which are defined by how they are connected to other ASs. Amultihomed AS is
connected to at least two other ASs and has the benefit of redundancy: if one of those ASs goes down, your AS
can still reach the Internet through its other connection. A stub AS has only one connection, and can be useful in
specific configurations where limited access is desirable.

Each AS has a number assigned to it, known as an ASN. In an internal network, you can assign any ASN you like
(a private AS number), but for networks connected to the Internet (public AS), you need to have an officially
registered ASN from the Internet Assigned Numbers Authority (IANA). ASNs from 1 to 64,511 are designated for
public use.

NAs of January 2010, AS numbers are 4 bytes long, instead of the former 2 bytes.
RFC 4893 introduced 32-bit ASNs, which FortiGate units support for BGP and OSPF.

Do you need your own AS?

The main factors in deciding if you need your own AS, or if you should be part of someone else’s are:
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l Exchanging external routing information
l Many prefixes should exist in one AS as long as they use the same routing policy
l When you use a different routing protocol than your border gateway peers. For example, your ISP uses BGP and

you use OSPF.
l Connected to many other ASs (multi-homed)

You should not create an AS for each prefix on your network. You also should not be forced into an AS just so
someone else can make AS-based policy decisions on your traffic.

There can be only one AS for any prefix on the Internet. This is to prevent routing issues.

What AS number should you use?

In addition to overseeing IP address allocation and Domain Name Systems (DNS), the Internet Assigned
Numbers Authority (IANA) assigns public AS numbers. The public AS numbers range from 1 to 64,511. The ASNs
0, 54272 to 64511, and 65535 are reserved by the IANA and should not be used.

ASNs are assigned in blocks by the Internet Assigned Numbers Authority (IANA) to Regional Internet Registries
(RIR), who then assign ASNs to companies within the geographic area of the RIR. These companies are usually
ISPs, and to receive an ASN you must complete the application process of the local RIR and be approved before
being assigned an ASN. The following table shows the names and regions of the RIRs:

AFRINIC Serves the African continent

APNIC Asia-Pacific, including China, India, and Japan

ARIN American registry, including Canada and United States

LACNIC Latin America, including Mexico, Caribbean, Central and South America

RIPE NCC Europe, the Middle East,the former USSR, and parts of Central Asia

AS numbers from 64512 to 65534 are reserved for private use. Private AS numbers can be used for any internal
networks with no outside connections to the Internet, such as test networks, classroom labs, and other internal-
only networks that do not access the outside world. You can also configure border routers to filter out any private
ASNs before routing traffic to the outside world. If you must use private ASNs with public networks, this is the only
way to configure them. However, it is risky because many other private networks could be using the same ASNs
and conflicts couldl happen. It would be like your local 192.168.0.0 network being made public and the resulting
problems would be widespread.

In 1996, when RFC 1930 was written, only 5,100 ASs had been allocated and a little under 600 ASs were actively
routed in the global Internet. Since that time, many more public ASNs have been assigned, leaving only a small
number. For this reason 32-bit ASNs (four-octet ASNs) were defined to provide more public ASNs. RFC 4893
defines 32-bit ASNs, and FortiGate units support these larger ASNs.

Area border router

Routers within an AS advertise updates internally and only to each other. However, routers on the edge of the AS
must communicate both with routers inside their AS and routers external to their AS, which are often running a
different routing protocol. These routers are called Area Border Routers (ABRs) or edge routers. ABRs often run
multiple routing protocols in order to redistribute traffic between different ASs that are running different protocols,
such as the edge between an ISP’s IS-IS routing network and a large company’s OSPF network.
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OSPF defines ABRs differently from other routers. In OSPF, an ABR is an OSPF router that connects another AS
to the backbone AS, and is a member of all the areas it connects to. An OSPF ABRmaintains an LSA database
for each area that it is connected to. The concept of the edge router is present, but it is the edge of the backbone
instead of the edge of the OSPF supported ASs.

Neighbor routers

Routing involves routers communicating with each other. To do this, routers need to know information about each
other. These routers are called neighbor routers and are configured in each routing protocol. Each neighbor has
custom settings since some routers may have functionality that other routers lack. Neighbor routers are
sometimes called peers.

Generally, neighbor routers must be configured and discovered by the rest of the network before they can be
integrated into the routing calculations. This is a combination of the network administrator configuring the new
router with its neighbor router addresses, and the routing network discovering the new router, such as the hello
packets in OSPF. That discovery initiates communication between the new router and the rest of the network.

Route maps

Route maps are a way for the FortiGate unit to evaluate optimum routes for forwarding packets or suppressing
the routing of packets to particular destinations. Compared to access lists, route maps support enhanced packet-
matching criteria. In addition, route maps can be configured to permit or deny the addition of routes to the
FortiGate unit routing table and make changes to routing information dynamically as defined through route-map
rules.

Route maps can be used for limiting both received route updates and sent route updates. This can include the
redistribution of routes learned from other types of routing. For example, if you do not want to advertise local
static routes to external networks, you could use a route map to accomplish this.

The FortiGate unit compares the rules in a route map to the attributes of a route. The rules are examined in
ascending order until one or more of the rules in the route map are found to match one or more of the route
attributes.

As an administrator, route maps allow you to group a set of addresses together and assign them a meaningful
name. During your configuration, you can use these route-maps to speed up configuration. The meaningful
names also ensure that fewer mistakes are made during configuration.

The default rule in the route map, which the FortiGate unit applies last, denies all routes. For a route map to take
effect, it must be called by a FortiGate unit routing process.

The syntax for route maps are:

config router route-map
edit <route_map_name>

set comments
config rule

edit <route_map_rule_id>
set action
set match-*
set set-*
...

end

The match-* commands allow you to match various parts of a route. The set-* commands allow you to set
routing information once a route is matched.
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For an example of how route maps can be used to create receiving or sending “groups” in routing, see BGP on
page 2598.

Access lists

Use this command to add, edit, or delete access lists. Access lists are filters used by FortiGate unit routing
processes. For an access list to take effect, it must be called by a FortiGate unit routing process (for example, a
process that supports RIP or OSPF). Use access-list6 for IPv6 routing.

Access lists can be used to filter which updates are passed between routers or which routes are redistributed to
different networks and routing protocols. You can create lists of rules that will match all routes for a specific router
or group of routers.

Each rule in an access list consists of a prefix (IP address and netmask), the action to take for this prefix (permit or
deny), and whether to match the prefix exactly or match the prefix and a more specific prefix.

If you are setting a prefix of 128.0.0.0, use the format 128.0.0.0/1. The default route,
0.0.0.0/0 cannot be exactly matched with an access-list. A prefix-list must be used for
this purpose.

The FortiGate unit attempts to match a packet against the rules in an access list, starting at the top of the list. If it
finds a match for the prefix, it takes the action specified for that prefix. If no match is found, the default action is
deny.

The syntax for access lists is:

config router access-list, access-list6
edit <access_list_name>

set comments
config rule
edit <access_list_id>

set action
set exact-match
set prefix
set prefix6
set wildcard

For an example of how access lists can be used to create receiving or sending “groups” in routing, see BGP on
page 2598.

Bi-directional forwarding detection

Bi-directional Forwarding Detection (BFD) is a protocol used to quickly locate hardware failures in the network.
Routers running BFD send packets to each other at a negotiated rate. If packets from a BFD-protected router fail
to arrive, then that router is declared to be down. BFD communicates this information to the routing protocol and
the routing information is updated.

BFD neighbors establish if BFD is enabled in OSPF, or BFP routers establish as neighbors.

The CLI commands associated with BFD include:

config router bgp
config neighbor

set bfd
end
config router ospf

set bfd
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end

Per-VDOM configuration:

config system settings
set bfd
set bfd-desired-min-tx
set bfd-required-min-rx
set bfd-detect-mult
set bfd-dont-enforce-src-port

end

Per-interface (override) configuration:

config system interface
edit <interface_name>

set bfd enable
set bfd-desired-min-tx
set bfd-detect-mult
set bfd-required-min-rx

end

For more information about BFD in BGP, see BGP on page 2598.

Controlling how routing changes affect active sessions
Dynamic routing changes can occur while the FortiGate unit is processing traffic. Routing changes that affect the
routes being used for current sessions, may affect how the FortiGate continues to process the session. In FortiOS
5.6.1 and later, you can control how active sessions are affected when dynamic routing changes occur that
affects the routes the active sessions are using.

You can configure whether the FortiGate maintains the original routing for the sessions that are using the
affected routes, or applies the routing table changes to the active sessions, which may cause destinations to
change.

Configure how dynamic routing changes affect active sessions

To configure how dynamic routing changes affect active sessions, use the following CLI commands:

config system interface
edit <port#>

set preserve-session-route {enable | disable}
end

CLI option Description

<port#1> The name of the interface where you want to configure how dynamic routing
changes affect active sessions running through it.

enable All sessions passing through the interface when the routing changes occur, are
allowed to finish and are not affected by the routing changes.

disable (default) When a routing change occurs, the new routing table is applied to the active
sessions passing through the interface. The routing changes may cause the
destinations of the sessions to change.
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IPv6 in dynamic routing
Unless otherwise stated, routing protocols apply to IPv4 addressing. This is the standard address format used.
However, IPv6 is becoming more popular and new versions of the dynamic routing protocols have been
introduced.

Dynamic routing supports IPv6 on your FortiGate unit. The new versions of these protocols and the corresponding
RFCs are:

l RIP next generation (RIPng)— RFC 2080 - Routing Information Protocol next generation (RIPng). See RIP and
IPv6.

l BGP4+— RFC 2545, and RFC 2858 Multiprotocol Extensions for IPv6 Inter-Domain Routing, and Multiprotocol
Extensions for BGP-4 (MP-BGP) respectively. See BGP and IPv6.

l OSPFv3— RFC 2740 Open Shortest Path First version 3 (OSPFv3) for IPv6 support. See OSPFv3 and IPv6.
l Integrated IS-IS— RFC 5308 for IPv6 support. See Integrated IS-IS.

As with most advanced routing features on your FortiGate unit, IPv6 settings for dynamic routing protocols must
be enabled before they will be visible in the GUI. To enable IPv6 configuration in the GUI, enable it in System >
Admin > Settings. Alternatively, you can directly configure IPv6 for RIP, BGP, or OSPF protocols using CLI
commands.
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RIP

This section describes the Routing Information Protocol (RIP).

RIP background and concepts

Background

Routing Information Protocol (RIP) is a distance-vector routing protocol intended for small, relatively
homogeneous networks. Its widespread use started when an early version of RIP was included with BSD v4.3
Linux as the routed daemon. The Bellman–Ford algorithm, which is the routing algorithm used by RIP, first saw
widespread use as the initial routing algorithm of the ARPANET.

RIP has many benefits. It is well suited to smaller networks, has near universal support on routing hardware, is
quick to configure, works well if there are no redundant paths, and is in widespread use. However, because RIP
updates are sent out node-by-node, it can be slow to find a path around network outages. RIP also lacks good
authentication, cannot choose routes based on different quality of service methods, and can create network loops
if you are not careful.

The FortiGate implementation of RIP supports RIP version 1 (see RFC 1058), RIP version 2 (see RFC 2453), and
the IPv6 version RIPng (see RFC 2080).

RIPv1

In 1988, RIP version 1 (RIPv1) was released. It is defined in RFC 1058. It uses classful addressing and uses
broadcasting to send out updates to router neighbors. There is no subnet information included in the routing
updates in classful routing. It does not support CIDR addressing and subnets must all be the same size. Also,
route summarization is not possible. RIPv1 has no router authentication method, so it is vulnerable to attacks
through packet sniffing and spoofing.

RIPv2

In 1993, RIP version 2 (RIPv2) was developed to deal with the limitations of RIPv1. It was not standardized until
1998. This new version supports classless routing and subnets of various sizes. Router authentication was added,
which supports MD5. MD5 hashes are an older encryption method, but this is much improved over no security at
all. In RIPv2, the hop count limit remained at 15, in order to be backwards compatible with RIPv1. It also uses
multicasting to send the entire routing table to router neighbors, which reduces the traffic for devices that are not
participating in RIP routing. Routing tags were also added, which allow internal routes or redistributed routes to
be identified as such.

RIPng

RIPng, defined in RFC 2080, is an extension of RIPv2 and is designed to support IPv6. However, RIPng varies
from RIPv2 in that it is not fully backwards compatible with RIPv1. RIPng does not support RIPv1 update
authentication and relies on IPsec instead. It does not allow the attaching of tags to routes, as in RIPv2. RIPng
requires specific encoding of the next hop for a set of route entries, unlike RIPv2 that encodes the next-hop into
each route entry.
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RIP terminology and parts

Before you can understand how RIP functions, you need to understand some of the main concepts and parts of
RIP.

RIP and IPv6

RIP Next Generation (RIPng) is a new version of RIP and includes support for IPv6.

The FortiGate unit command config router ripng is almost the same as config router rip, except
that IPv6 addresses are used. Also, if you are going to use prefix or access lists with RIPng, you must use the
config router access-list6 or config prefix-list6 versions of those commands.

If you want to troubleshoot RIPng, it is the same as with RIP but specify the different protocol and use IPv6
addresses. This applies to commands such as get router info6 when you want to see the routing table or
other related information.

If you want to route IPv4 traffic over an IPv6 network, you can use the command config system ip6-
tunnel to configure the FortiGate unit to do this. The IPv6 interface is configured under config system
interface.All subnets between the source and destination addresses must support IPv6. This command is
not supported in transparent mode.

For example, if you want to set up a tunnel on the port1 interface starting at 2002:C0A8:3201:: on your local
network and tunnel it to address 2002:A0A:A01::, where it will need access to an IPv4 network again, use the
following commands:

config system ipv6-tunnel
edit test_tunnel

set destination 2002:A0A:A01::
set interface port1
set source 2002:C0A8:3201::

end
end

The CLI commands associated with RIPng include:

config router ripng
config router access-list6
config router prefix-list6
config system ipv6-tunnel
get router info6 *

Default information originate option

The default information originate option is the second advanced option for RIP in the web-based manager, right
after metric. Enabling default-information-originate will generate and advertise a default route into the FortiGate
unit’s RIP-enabled networks. The generated route may be based on routes learned through a dynamic routing
protocol, routes in the routing table, or both. RIP does not create the default route unless you use the always
option.

Select Disable if you experience any issues or if you wish to advertise your own static routes into RIP updates.

You can enable or disable default-information-originate in Router > Dynamic > RIP, underAdvanced
Options, or use the CLI.

The CLI commands associated with default information originate include:

config router rip
set default-information-originate
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end

Update, timeout, and garbage timers

RIP uses various timers to regulate its performance including an update timer, a timeout timer, and a garbage
timer. The FortiGate unit's default timer settings (30, 180, and 120 seconds) are effective in most configurations.
If you change these settings, ensure that the new settings are compatible with local routers and access servers.

The timeout period should be at least three times longer than the update period. If the update timer is
smaller than the timeout or garbage timers, you will experience an error.

You can set the three RIP timers in Router > Dynamic > RIP, underAdvanced Options, or use the CLI.

The CLI commands associated with garbage, timeout, and update timers include:

config router rip
set timeout-timer
set update-timer
set garbage-timer

end

Update timer

The update timer determines the interval between routing updates. This value is usually set to 30 seconds. There
is some randomness added to help prevent network traffic congestion, which could result from all routers
attempting to update their neighbors simultaneously. The update timer should be at least three times smaller
than the timeout timer or you will experience an error.

If you are experiencing significant RIP traffic on your network, you can increase this interval to send fewer
updates per minute. However, ensure you increase the interval for all the routers on your network or you will
experience timeouts that will degrade your network speed.

Timeout timer

The timeout timer is the maximum amount of time (in seconds) that a route is considered reachable while no
updates are received for the route. This is the maximum time the FortiGate unit will keep a reachable route in the
routing table while no updates for that route are received. If the FortiGate unit receives an update for the route
before the timeout period expires, the timer is restarted. The timeout period should be at least three times longer
than the update period or you will experience an error.

If you are experiencing problems with routers not responding in time to updates, increase this timer. However,
remember that longer timeout intervals result in longer overall update periods. It may be a considerable amount
of time before the FortiGate unit is done waiting for all the timers to expire on unresponsive routes.

Garbage timer

The garbage timer is the amount of time (in seconds) that the FortiGate unit will advertise a route as being
unreachable before deleting the route from the routing table. If this timer is shorter, it will keep more up-to-date
routes in the routing table and remove older ones faster. This will result in a smaller routing table, which is useful
if you have a very large network, or if your network changes frequently.

Authentication and key chain

RIP version 2 (RIPv2) uses authentication keys to ensure that the routing information exchanged between routers
is reliable. RIP version 1 (RIPv1) has no authentication. For authentication to work, both the sending and
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receiving routers must be set to use authentication and must be configured with the same keys.

The sending and receiving routers need to have their system dates and times synchronized to ensure both ends
are using the same keys at the proper times. However, you can overlap the key lifetimes to ensure that a key is
always available even if there is some difference in the system times.

A key chain is a list of one or more authentication keys, including the send and receive lifetimes for each key.
Keys are used for authenticating routing packets only during the specified lifetimes. The FortiGate unit migrates
from one key to the next according to the scheduled send and receive lifetimes.

The key-chain command is a CLI router command. You use this command to manage RIPv2 authentication keys.
You can add, edit, or delete keys identified by the specified key number.

This example shows how to configure a key chain with two keys that are valid sequentially in time. This example
creates a key chain called “rip_key” that has a password of “fortinet”. The accepted and send lifetimes are both
set to the same values: a start time of 9:00 am on February 23, 2010 and an end time of 9:00 am on March 17,
2010. A second key is configured with a password of “my_fortigate” that is valid from March 17, 2010 9:01am to
April 1 2010 9:00am. This “rip_key” key chain is then used on the port1 interface in RIP.

config router key-chain
edit "rip_key"

config key
edit 1

set accept-lifetime 09:00:00 23 02 2010 09:00:00 17 03 2010
set key-string "fortinet"
set send-lifetime 09:00:00 23 02 2010 09:00:00 17 03 2010

next
edit 2

set accept-lifetime 09:01:00 17 03 2010 09:00:00 1 04 2010
set key-string "my_fortigate"
set send-lifetime 09:01:00 17 03 2010 09:00:00 1 04 2010

next
end

end
config router rip

config interface
edit port1

set auth-keychain "rip_key"
end

end

The CLI commands associated with authentication keys include:

config router key-chain

config router rip
config interface

edit <interface>
set auth-keychain
set auth-mode
set auth-string

end
end
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Access lists

Access lists are filters used by the FortiGate unit's RIP and OSPF routing. An access list provides a list of IP
addresses and the action to take for them. Essentially, an access list makes it easy to group addresses that will
be treated the same way into the same group, independent of their subnets or other matching qualities. You add
a rule for each address or subnet that you want to include and specify the action to take for it. For example, if you
want all traffic from one department to be routed a particular way, even in different buildings, you can add all of
the addresses to an access list and then handle that list all at once.

Each rule in an access list consists of a prefix (IP address and netmask), the action to take for this prefix (permit or
deny), and whether to match the prefix exactly or to match the prefix and any more specific prefix.

The FortiGate unit attempts to match a packet against the rules in an access list, starting at the top of the list. If it
finds a match for the prefix, it takes the action specified for that prefix. If no match is found, the default action is
deny.

Access lists greatly speed up configuration and network management. When there is a problem, you can check
each list instead of individual addresses. Also, it is easier to troubleshoot because if all addresses on one list have
problems, many possible causes can be eliminated right away.

If you are using the RIPng or OSPF+ IPv6 protocols, you will need to use access-list6, which is the IPv6 version of
the access list. The only difference is that access-list6 uses IPv6 addresses.

For example, if you want to create an access list called test_list that only allows an exact match of
10.10.10.10 and 11.11.11.11, enter the command:

config router access-list
edit test_list

config rule
edit 1

set prefix 10.10.10.10 255.255.255.255
set action allow
set exact-match enable

next
edit 2

set prefix 11.11.11.11 255.255.255.255
set action allow
set exact-match enable

end
end

Another example is if you want to deny ranges of addresses in IPv6 that start with the IPv6 equivalents of
10.10.10.10 and 11.11.11.11, enter the access-list6 command, as follows:

config router access-list6
edit test_list_ip6

config rule
edit 1

set prefix6 2002:A0A:A0A:0:0:0:0:0:/48
set action deny

next
edit 2

set prefix6 2002:B0B:B0B:0:0:0:0:0/48
set action deny

end
end
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To use an access list, you must call it from a routing protocol, such as RIP. The following example uses the
access list from the previous example, called test_list, to match routes coming in on the port1 interface. When
there is a match, it will add 3 to the hop count metric for those routes to artificially increase. Enter the following
command:

config router rip
config offset-list

edit 5
set access-list test_list
set direction in
set interface port1
set offset 3
set status enable

end

If you are setting a prefix of 128.0.0.0, use the format 128.0.0.0/1. The default route, 0.0.0.0/0 cannot be exactly
matched with an access list. A prefix list must be used for this purpose

How RIP works

As one of the original modern dynamic routing protocols, RIP is straightforward. Its routing algorithm is not
complex and there are some options that allow fine tuning. It is relatively simple to configure RIP on FortiGate
units.

From RFC 1058:

Distance vector algorithms are based on the exchange of only a small amount of information. Each
entity (gateway or host) that participates in the routing protocol is assumed to keep information
about all of the destinations within the system. Generally, information about all entities connected
to one network is summarized by a single entry, which describes the route to all destinations on
that network.

This section includes:

l RIP versus static routing
l RIP hop count
l The Bellman–Ford routing algorithm
l Passive versus active RIP interfaces
l RIP packet structure

RIP versus static routing

RIP was one of the earliest dynamic routing protocols to work with IP addresses. As such, it is not as complex as
more recent protocols. However, RIP is a big step forward from simple static routing.

While RIPmay be slow in response to network outages, static routing has zero response. The same is true for
convergence; static routing has zero convergence. Both RIP and static routing have the limited hop count, so it is
not a strength or a weakness. Count to infinity can be a problem, but can typically be fixed as it happens, or is the
result of a network outage that would cause even worse problems on a static routing network.

This compares to static routing where each time a packet needs to be routed, the FortiGate unit can send it only
to the next hop towards the destination. That next hop then forwards it, and so on until it arrives at its destination.
RIP keeps more routing information on each router so your FortiGate unit can send the packet further towards its
destination before it has to be routed again toward its destination. RIP uses a smaller amount of table lookups,
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and therefore fewer network resources, than static routing. Also, since RIP is updated on neighboring routes, it is
aware of new routes or dead routes that static routing would not be aware of.

Overall, RIP is a large step forward when compared to static routing.

RIP hop count

RIP uses hop count as the metric for choosing the best route. A hop count of 1 represents a network that is
connected directly to the FortiGate unit, while a hop count of 16 represents a network that cannot be reached.
Each network that a packet travels through to reach its destination usually counts as one hop. When the
FortiGate unit compares two routes to the same destination, it adds the route having the lowest hop count to the
routing table. As you can see in RIP packet structure on page 2529, the hop count is part of a RIP v2 packet.

Similarly, when RIP is enabled on an interface, the FortiGate unit sends RIP responses to neighboring routers on
a regular basis. The updates provide information about the routes in the FortiGate unit’s routing table, subject to
the rules that you specify for advertising those routes. You can specify how often the FortiGate unit sends
updates, the period of time a route can be kept in the routing table without being updated, and for routes that are
not updated regularly, you can specify the period of time that the unit advertises a route as unreachable before it
is removed from the routing table.

If hops are weighted higher than one, it is very easy to reach the upper limit. This higher weighting will effectively
limit the size of your network, depending on the numbers used. Merely changing from the default of 1.0 to 1.5 will
lower the effective hop count from 15 to 10. This is acceptable for smaller networks, but can be a problem as your
network expands over time.

In RIP, you can use the offset command to artificially increase the hop count of a route. Doing this will make this
route less preferred and, in turn, it will get less traffic. Offsetting routes is useful when you have network
connections that have different bandwidths, levels of reliability, or costs. In each of these situations you still want
the redundancy of multiple route access, but you do not want the bulk of your traffic using these less preferred
routes. For an example of RIP offset, see Access lists on page 2523.

The Bellman–Ford routing algorithm

The routing algorithm used by RIP was first used in 1967 as the initial routing algorithm of the ARPANET. The
Bellman–Ford algorithm is distributed because it involves a number of nodes (routers) within an Autonomous
system, and consists of the following steps:

1. Each node calculates the distances between itself and all other nodes within the AS and stores this information as
a table.

2. Each node sends its table to all neighboring nodes.
3. When a node receives distance tables from its neighbors, it calculates the shortest routes to all other nodes and

updates its own table to reflect any changes.
To examine how this algorithm functions let us look at a network with 4 routers: routers 1 through 4. The distance
from Router1 to Router2 is 2 hops, Router1 to Router3 is 3 hops, and Router2 to Router3 is 4 hops. Router4 is
only connected to Router2 and Router3, each distance being 2 hops.

1. Router1 finds all of the distances to the other three routers: Router 2 is 2, Router 3 is 3. Router1 does not have a
route to Router4.

2. Router2, Router3, and Router4 perform the same calculations from their point of views.
3. Once Router1 gets an update from Router 2 or Router3, it will get their route to Router4. At that point, it now has a

route to Router4 and installs that in its local table.
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4. If Router1 gets an update from Router3 first, it has a hop count of 5 to reach Router4, but when Router2 sends its
update, Router1 will go with Router2’s shorter 4 hops to reach Router4. Future updates do not change this unless
they are shorter than 4 hops or the routing table route goes down.

RIP algorithm example in four steps

Step 1

Router1 finds the distance to other routers in the network.

It currently has no route to Router4.

Router1 routing table:

l Distance to Router2 = 2 hops
l Distance to Router3 = 3 hops

Step 2

All routers do the same as Router1 and send out updates containing their routing table.

Note that Router1 and Router4 do not update each other, but rely on Router2 and Router3 to pass along accurate
updates.
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Step 3

Each router looks at the updates it has received and adds any new or shorter routes to its table.

Router1's updated table:

l Distance to Router2 = 2 hops
l Distance to Router3 = 3 hops
l Distance to Router4 = 4 or 5 hops

Step 4

Router1 installs the shortest route to Router4 and the other routes to it are removed from the routing table.

Router1's complete table:

l Distance to Router2 = 2 hops
l Distance to Router3 = 3 hops
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l Distance to Router4 = 4 hops

The good part about the Bellman-Ford algorithm in RIP is that the router only uses the information it needs from
the update. If there are no newer, better routes than the ones the router already has in its routing table, there is
no need to change its routing table. And no change means no additional update, and therefore less traffic. But
even when there is update traffic, the RIP packets are very small so it takes many updates to affect overall
network bandwidth. For more information about RIP packets, see RIP packet structure on page 2529.

The main disadvantage of the Bellman–Ford algorithm in RIP is that it does not take weightings into
consideration. While it is possible to assign different weights to routes in RIP, doing so severely limits the
effective network size by reducing the hop count limit. Also, other dynamic routing protocols can take route
qualities, such as reliability or delay, into consideration to provide not only the physically shortest routes but also
the fastest or more reliable routes.

Another disadvantage of the Bellman-Ford algorithm is due to the slow updates passed from one RIP router to
the next. This results in a slow response to changes in the network topology, which in turn results in more
attempts to use routes that are down and that wastes time and network resources.

Passive versus active RIP interfaces

Normally, the FortiGate unit’s routing table is kept up to date by periodically asking the neighbors for routes, and
sending your routing updates out. This has the downside of generating a lot of extra traffic for large networks. The
solution to this problem is passive interfaces.

A standard interface that supports RIP is active, by default. It sends and receives updates by actively
communicating with its neighbors. A passive RIP interface does not send out updates. It only listens to the
updates of other routers. This is useful in reducing network traffic, and if there are redundant routers in the
network that will send out essentially the same updates all the time.

The following example shows how to create a passive RIPv2 interface on port1 using MD5 authentication and a
key chain called passiveRIPv2, which has already been configured. Note that in the CLI, you enable passive
by disabling send-version2-broadcast.

2528 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



RIP

To create a passive RIP interface - web-based manager

1. Go to Router > Dynamic > RIP.
2. Next to Interfaces, select Create.
3. Select port1 as the Interface.
4. Select 2 as both the Send Version and Receive Version.
5. Select MD5 forAuthentication.
6. Select the passiveRIPv2Key-chain.
7. Select Passive Interface.
8. Select OK to accept this configuration and return to the main RIP display page.

To create a passive RIP v2 interface on port1 using MD5 authentication - CLI

config router rip
config interface

edit port1
set send-version2-broadcast disable
set auth-keychain "passiveRIPv2"
set auth-mode md5
set receive-version 2
set send-version 2

end
end

RIP packet structure

It is hard to fully understand a routing protocol without knowing what information is carried in its packets. Knowing
what information is exchanged between routers and how it is exchanged will help you to better understand the
RIP protocol and better configure your network for it.

This section provides information about the contents of RIPv1 and RIPv2 packets.

RIP version 1

RIP version 1 (RIPv1), or RIP IP, packets are 24 bytes in length with some empty areas left for future expansion.

RIP IP packets

1-byte command 1-byte version 2-byte zero field 2-byte AFI 2-byte zero field

4-byte IP address 4-byte zero field 4-byte zero field 4-byte metric

A RIPv1 packet contains the following fields:

l Command: Indicates whether the packet is a request or a response. The request asks that a router send all or part
of its routing table. The response can be an unsolicited regular routing update or a reply to a request. Responses
contain routing table entries. Multiple RIP packets are used to convey information from large routing tables.

l Version: Specifies the RIP version used. This field can signal different, potentially incompatible versions.
l Zero field: This field defaults to zero and is not used by RFC 1058 RIP.
l Address-family identifier (AFI): Specifies the address family used. RIP is designed to carry routing information

for several different protocols. Each entry has an address-family identifier to indicate the type of address being
specified. The AFI for IP is 2.
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l IP Address: Specifies the IP address for the entry.
l Metric: This is the number of hops or routers traversed along the route on its trip to the destination. The metric is

between 1 and 15 for that number of hops. If the route is unreachable, the metric is 16.

RIP version 2

RIP version 2 (RIPv2) has more features than RIPv1, which is reflected in its packets that carry more information.
All but one of the empty zero fields in RIPv1 packets are used in RIPv2.

RIPv2 packets

1-byte command 1-byte version 2-byte unused 2-byte AFI 2-byte route tag

4-byte IP address 4-byte subnet 4-byte next hop 4-byte metric

A RIPv2 packet contains the fields described above for RIPv1, as well as the following:

l Unused: Has a value set to zero and is intended for future use
l Route tag: Provides a method for distinguishing between internal routes learned by RIP and external routes

learned from other protocols.
l Subnet mask: Contains the subnet mask for the entry. If this field is zero, no subnet mask has been specified for

the entry.
l Next hop: Indicates the IP address of the next hop to which packets for the entry should be forwarded.

Troubleshooting RIP
This section is about troubleshooting RIP. For general troubleshooting information, see the FortiOS Handbook
Troubleshooting chapter.

Routing loops

Normally in routing, a path between two addresses is chosen and traffic is routed along that path from one
address to the other. When there is a routing loop, that normal path doubles back on itself, creating a loop. When
there are loops, the network has problems getting information to its destination. Loops also prevent the network
from returning to the source to report the inaccessible destination.

A routing loop occurs when a normally functioning network has an outage and one or more routers are offline.
When packets encounter this, they attempt an alternate route maneuver around the outage. During this phase, it
is possible for a route to be attempted that involves going back a hop, and trying a different hop forward. If that
hop forward is also blocked by the outage, a hop back, and possibly the original hop forward, may be selected. If
this continues, it can consume not only network bandwidth but also many resources on the affected routers. The
worst part is this situation will continue until the network administrator changes the router settings or the downed
routers come back online.

Effect of routing loops on the network

In addition to this “traffic jam” of routed packets, every time the routing table for a router changes, that router
sends an update out to all of the RIP routers connected to it. In a network loop, it is possible for a router to change
its routes very quickly as it tries and fails along these new routes. This can quickly result in a flood of updates
being sent out, which can effectively grind the network to a halt until the problem is fixed.
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How to spot a routing loop

Anytime network traffic slows down, you will ask yourself if it is a network loop. Slowdowns are often normal, are
not a full stoppage, and normal traffic resumes in a short period of time.

If the slow down is a full halt of traffic or a major slowdown that does not return to normal quickly, you need to do
serious troubleshooting quickly.

If you are not running SNMP, dead gateway detection, or you have non-Fortinet routers in your network, you can
use networking tools such as ping and traceroute to define the outage on your network and begin to fix it. Ping,
traceroute, and other basic troubleshooting tools are largely the same between static and dynamic and are
covered in Advanced static routing on page 2473.

Check your logs

If your routers log events to a central location, it can be easy to check your network logs for any outages.

On your FortiGate unit, go to Log & Report. You should look at both event logs and traffic logs. Events to look
for will generally fall under CPU and memory usage, interfaces going offline (due to dead gateway detection), and
other similar system events.

Once you have found and fixed your network problem, you can go back to the logs and create a report to better
see how things developed during the problem. This type of forensics analysis can better help you prepare for next
time.

Use SNMP network monitoring

If your network had no problems one minute and slows to a halt the next, chances are something changed to
cause that problem. Most of the time an offline router is the cause and once you find that router and bring it back
online, things will return to normal.

If you can enable a hardware monitoring system such as SNMP or sFlow on your routers, you can be notified of
the outage and its location as soon as it happens.

Ideally you can configure SNMP on all your FortiGate routers and be alerted to all outages as they occur.

To use SNMP to detect potential routing loops

1. Go to System > Config > SNMP.
2. Enable SMTP Agent and select Apply.

Optionally, enter the Description, Location, and Contact information for this device for easier
location of the problem report.

3. Under SNMP v1/v2 or SNMP v3 as appropriate, select Create New.
SNMP v3

User Name Enter the SNMP user ID.

Security Level Select authentication or privacy as desired. Select the authentication or privacy
algorithms to use and enter the required passwords.

Notification Host Enter the IP addresses of up to 16 hosts to notify.
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Enable Query Select. The Port should be 161. Ensure that your security policies allow ports 161 and
162 (SNMP queries and traps) to pass.

SNMP v1/v2

Hosts Enter the IP addresses of up to 8 hosts to notify.

Queries Enable v1 and/or v2 as needed. The Port should be 161. Ensure that your security
policies allow port 161 to pass.

Traps Enable v1 and/or v2 as needed. The Port should be 162. Ensure that your security
policies allow port 162 to pass.

4. Select the events for which you want notification. For routing loops this should include CPU usage is high,
Memory is low, and possibly Log disk space is low. If there are problems the log will fill up quickly and the
FortiGate unit’s resources will be overused.

5. Configure SNMP host (manager) software on your administration computer. This will monitor the SNMP
information sent out by the FortiGate unit. Typically you can configure this software to alert you to outages or CPU
spikes that may indicate a routing loop.

Use Link Health Monitor and email alerts

Another tool available to you on FortiGate units is the Link Health Monitor, which is useful for dead gateway
detection. This feature allows the FortiGate unit to ping a gateway at regular intervals to ensure it is online and
working. When the gateway is not accessible, that interface is marked as down.

To detect possible routing loops with Link Health Monitor and email alerts

Use the following command to configure dead gateway detection:

config system link-monitor
edit "test"

set srcintf "internal4"
set server "8.8.8.8"
set interval 5
set failtime 1

end

Set the Interval (how often to send a ping) and failtime (how many lost pings are considered a failure). A
smaller interval and smaller number of lost pings will result in faster detection, but will create more traffic on your
network.

To configure notification of failed gateways

1. Go to Log & Report > Report > Local and enable Email Generated Reports.
2. Enter your email details.
3. Select Apply.
You might also want to log CPU and Memory usage as a network outage will cause your CPU activity to spike.
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If you have VDOMs configured, you will have to enter the basic SMTP server
information in the Global section, and the rest of the configuration within the VDOM
that includes this interface.

After this configuration, when this interface on the FortiGate unit cannot connect to the next router, the FortiGate
unit will bring down the interface and alert you with an email about the outage.

Look at the packet flow

If you want to see what is happening on your network, look at the packets traveling on the network. This is the
same idea as police pulling over a car and asking the driver where they have been and what the conditions were
like.

The method used in the troubleshooting sections Debugging IPv6 on RIPng on page 2534 and on debugging the
packet flow also apply here. In this situation, you are looking for routes that have metrics higher than 15 as that
indicates they are unreachable.

Ideally, if you debug the flow of the packets and record the routes that are unreachable, you can create an
accurate picture of the network outage.

Action to take on discovering a routing loop

Once you have mapped the problem on your network and determined that it is a routing loop, there are a number
of steps you can take to correct it:

1. Get any offline routers back online. This may be a simple reboot, or you may have to replace hardware. Often, this
first step will restore your network to its normal operation, once the routing tables are updated.

2. Change your routing configuration on the edges of the outage. Even if step 1 brought your network back online,
you should consider making changes to improve your network before the next outage occurs. These changes can
include configuring features like holddowns and triggers for updates, split horizon, and poison reverse updates.

Holddowns and triggers for updates

One of the potential problems with RIP is the frequent routing table updates that are sent every time there is a
change to the routing table. If your network has many RIP routers, these updates can start to slow your network
down. Also, if you have a particular route that has bad hardware, it might be going up and down frequently, which
will generate an overload of routing table updates.

One of the most common solutions to this problem is to use holddown timers and triggers for updates. These
slow down the updates that are sent out and help prevent a potential flood.

Holddown timers

The holddown timer activates when a route is marked down. Until the timer expires, the router does not accept
any new information about that route. This is very useful if you have a flapping route because it will prevent your
router from sending out updates and being part of the problem in flooding the network. The potential downside is
if the route comes back up before the timer expires, that route will be unavailable for that period of time. This is
only a problem if this is a major route used by the majority of your traffic. Otherwise, this is a minor problem as
traffic can be re-routed around the outage.
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Triggers

Triggered RIP is an alternate update structure that is based around limiting updates to only specific
circumstances. The most basic difference is that the routing table will only be updated when a specific request is
sent to update, instead of every time the routing table changes. Updates are also triggered when a unit is
‘powered on’, which can include the addition of new interfaces or devices to the routing structure, or devices
returning to being available after being unreachable.

Split horizon and poison reverse updates

Split horizon is best explained with an example. If there are three routers linked serially, called routerA, routerB,
and routerC. RouterA is only linked to routerB, RouterC is only linked to routerB, and routerB is linked to both
routerA and routerC. To get to routerC, routerAmust go through routerB. If the link to routerC goes down, it is
possible that routerB will try to use routerA’s route to get to routerC. This route is A-B-C, so it will loop endlessly
between routerA and routerB.

This situation is called a split horizon because from routerB’s point of view the horizon stretches out in each
direction but in reality it is only on one side. Poison reverse is the method used to prevent routes from running into
split horizon problems. Poison reverse “poisons” routes away from the destination that use the current router in
their route to the destination. This poisoned route is marked as unreachable for routers that cannot use it. In RIP,
this means that the route is marked with a distance of 16.

Debugging IPv6 on RIPng

The debug commands are very useful to see what is happening on the network at the packet level. There are a
few changes to debugging the packet flow when debugging IPv6.

The following CLI commands specify both IPv6 and RIP, so only RIPng packets will be reported. The output from
these commands will show you the RIPng traffic on your FortiGate unit, including RECV, SEND, and UPDATE
actions.

The addresses are in IPv6 format.

diagnose debug enable
diagnose ipv6 router rip level info
diagnose ipv6 router rip all enable

These three commands will:

l turn on debugging, in general
l set the debug level to information, which is a verbose reporting level
l turn on all RIP router settings

Part of the information displayed from the debugging is the metric (hop count). If the metric is 16, then that
destination is unreachable, since the maximum hop count is 15.

In general, you should see an update announcement, followed by the routing table being sent out, and a reply
received in response.

For more information, see Troubleshooting RIP on page 2530.

Simple RIP example
This is an example of a typical medium-sized network configuration using RIP routing.
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Your company has 3 small local networks, one for each department. These networks are connected by RIP, and
then connected to the Internet. Each subnet has more than one route for redundancy. There are two central
routers that are both connected to the Internet and to the other networks. If one of those routers goes down, the
whole network can continue to function normally.

The ISP is running RIP, so no importing or exporting routes is required on the side of the network. However, since
the internal networks have static networking running, those will need to be redistributed through the RIP network.

To keep the example simple, there will be no authentication of router traffic.

With RIP properly configured, if the device fails or temporarily goes offline, the routes will change and traffic will
continue to flow. RIP is good for a smaller network due to its lack of complex configurations.

Network layout and assumptions

Basic network layout

Your company has 3 departments each with their own network: Sales, R&D, and Accounting. Each network has
routers that are not running RIP and FortiGate units running RIP.

The R&D network has two RIP routers, and each is connected to both other departments as well as being
connected to the Internet through the ISP router. The links to the Internet are indicated in black.

The three internal networks do not run RIP. They use static routing because they are small networks. This means
the FortiGate units have to redistribute any static routes they learn so that the internal networks can
communicate with each other.

Where possible in this example, the default values will be used (or the most general settings). This is intended to
provide an easier configuration that will require less troubleshooting.

In this example, the routers, networks, interfaces used, and IP addresses are as follows. Note that the interfaces
that connect Router2 and Router3 also connect to the R&D network.

RIP example network topology

Network Router Interface & alias IP address

Sales Router1 port1 (internal) 10.11.101.101

port2 (router2) 10.11.201.101

port3 (router3) 10.11.202.101
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Network Router Interface & alias IP address

R&D

Router2

port1 (internal) 10.12.101.102

port2 (router1) 10.11.201.102

port3 (router4) 10.14.201.102

port4 (ISP) 172.20.120.102

Router3

port1 (internal) 10.12.101.103

port2 (router1) 10.11.201.103

port3 (router4) 10.14.202.103

port4 (ISP) 172.20.120.103

Accounting Router4

port1 (internal) 10.14.101.104

port2 (router2) 10.14.201.104

port3 (router3) 10.14.202.104

Network topology for the simple RIP example
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Assumptions

The following assumptions have been made concerning this example:

l All FortiGate units have 5.0 firmware and are running factory default settings.
l All CLI and web-based manager navigation assumes the unit is running in NAT operating mode, with VDOMs

disabled.
l All FortiGate units have interfaces labeled port1 through port4, as required.
l All firewalls have been configured for each FortiGate unit to allow the required traffic to flow across interfaces.
l Only FortiGate units are running RIP on the internal networks.
l Router2 and Router3 are connected through the internal network for R&D.
l Router2 and Router3 each have their own connection to the Internet, indicated in black in the diagram above.

General configuration steps

This example is very straightforward. The only steps involved are:

l Configuring FortiGate system information
l Configuring FortiGate unit RIP router information
l Configuring other networking devices
l Testing network configuration

Configuring FortiGate system information

You must configure the hostname and interfaces for each FortiGate.

For IP numbering, Router2 and Router3 use the numbering for the other routers, where needed.

Router2 and Router3 have dead gateway detection enabled on the ISP interfaces using Ping. Remember to
contact the ISP and confirm their server has ping enabled.

Configure the hostname, interfaces, and default route

To configure Router1 system information - web-based manager

1. Go to System > Settings.
2. In the Host name field, enter Router1.
3. Go to Network > Static Routes.
4. Edit the default route and enter the following information:

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.5/255.255.255.0

Interface port2 (router2)

Administrative Distance 40

5. Enter a second default route and enter the following information:

Destination IP/Mask 0.0.0.0/0.0.0.0
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Gateway 172.20.120.5/255.255.255.0

Interface port3 (router3)

Administrative Distance 40

6. Go to Network > Interfaces.
7. Edit port1 (internal) interface.
8. Set the following information, and select OK.

Alias internal

IP/Network Mask 10.11.101.101/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Internal sales network

Interface State Enabled

9. Edit port2 (router2) interface.
10. Set the following information, and select OK.

Alias router2

IP/Network Mask 10.11.201.101/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to R&D network & Internet through Router2

Interface State Enabled

11. Edit port3 (router3) interface.
12. Set the following information, and select OK.

Alias router3

IP/Network Mask 10.11.202.101/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to R&D network and Internet through Router3

Interface State Enabled

To configure Router1 system information - CLI

config system global
set hostname Router1
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end

config router static
edit 1

set device "port2"
set distance 45
set gateway 10.11.201.102

next
edit 2

set device "port3"
set distance 45
set gateway 10.11.202.103

end
end

config system interface
edit port1

set alias internal
set ip 10.11.101.101/255.255.255.0
set allowaccess https ssh ping
set description "Internal sales network"

next
edit port2

set alias ISP
set allowaccess https ssh ping
set ip 10.11.201.101/255.255.255.0
set description "Link to R&D network & Internet through Router2"

next
edit port3

set alias router3
set ip 10.11.202.101/255.255.255.0
set allowaccess https ssh ping
set description "Link to R&D network & Internet through Router2"

end
end

To configure Router2 system information - web-based manager

1. Go to System > Settings.
2. In the Host name field, enter Router2.
3. Go to Network > Static Routes.
4. Edit the default route and enter the following information:

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.5/255.255.255.0

Interface port4 (ISP)

Administrative Distance 5

5. Go to Network > Interfaces.
6. Edit port1 (internal) interface.
7. Set the following information and select OK.
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Alias internal

IP/Network Mask 10.12.101.102/255.255.255.0

Administrative Access HTTPS SSH PING

Comments R&D internal network and Router3

Interface State Enabled

8. Edit port2 (router1) interface.
9. Set the following information and select OK.

Alias router1

IP/Network Mask 10.12.201.102/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to Router1 and the Sales network

Interface State Enabled

10. Edit port3 (router4) interface.
11. Set the following information and select OK.

Alias router4

IP/Network Mask 10.12.301.102/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to Router4 and the accounting network

Interface State Enabled

12. Edit port4 (ISP) interface.
13. Set the following information and select OK.

Alias ISP

IP/Network Mask 172.20.120.102/255.255.255.0

Administrative Access HTTPS SSH PING

Detect and Identify Devices enable

Comments Internet through ISP

Interface State Enabled
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To configure Router2 system information - CLI

config system global
set hostname Router2

end
config router static

edit 1
set device "port4"
set distance 5
set gateway 172.20.130.5

end
end
config system interface

edit port1
set alias internal
set ip 10.11.101.102/255.255.255.0
set allowaccess https ssh ping
set description "Internal RnD network and Router3"

next
edit port2

set alias router1
set allowaccess https ssh ping
set ip 10.11.201.102/255.255.255.0
set description "Link to Router1"

next
edit port3

set alias router3
set ip 10.14.202.102/255.255.255.0
set allowaccess https ssh ping
set description "Link to Router4"

next
edit port4

set alias ISP
set ip 172.20.120.102/255.255.255.0
set allowaccess https ssh ping
set description "ISP and Internet"

end
end

To configure Router3 system information - web-based manager

1. Go to System > Settings.
2. In the Host name field, enter Router3.
3. Go to Network > Static Routes.
4. Edit the default route and enter the following information:

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.5/255.255.255.0

Interface port4 (ISP)

Administrative Distance 5
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5. Go to Network > Interfaces.
6. Edit port1 (internal) interface.
7. Set the following information and select OK.

Alias internal

IP/Network Mask 10.12.101.103/255.255.255.0

Administrative Access HTTPS SSH PING

Comments R&D internal network and Router2

Interface State Enabled

8. Edit port2 (router1) interface.
9. Set the following information and select OK.

Alias router1

IP/Network Mask 10.13.201.103/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to Router1 and Sales network

Interface State Enabled

10. Edit port3 (router4) interface.
11. Set the following information and select OK.

Alias router4

IP/Network Mask 10.13.301.103/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to Router4 and accounting network

Interface State Enabled

12. Edit port4 (ISP) interface.
13. Set the following information and select OK.

Alias ISP

IP/Network Mask 172.20.120.103/255.255.255.0

Administrative Access HTTPS SSH PING
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Detect and Identify Devices enable

Comments Internet and ISP

Interface State Enabled

To configure Router3 system information - CLI

config system global
set hostname Router3

end
config router static

edit 1
set device "port4"
set distance 5
set gateway 172.20.130.5

end
end
config system interface

edit port1
set alias internal
set ip 10.12.101.103/255.255.255.0
set allowaccess https ssh ping
set description “Internal RnD network and Router2”

next
edit port2

set alias ISP
set allowaccess https ssh ping
set ip 10.11.201.103/255.255.255.0
set description “Link to Router1”

next
edit port3

set alias router3
set ip 10.14.202.103/255.255.255.0
set allowaccess https ssh ping
set description “Link to Router4”

next
edit port4

set alias ISP
set ip 172.20.120.103/255.255.255.0
set allowaccess https ssh ping
set description “ISP and Internet”

end
end

To configure Router4 system information - web-based manager

1. Go to System > Settings.
2. In the Host name field, enter Router4.
3. Go to Network > Static Routes.
4. Edit the default route and enter the following information:
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Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.5/255.255.255.0

Interface port2 (router2)

Administrative Distance 40

5. Enter a second default route and enter the following information:

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.20.120.5/255.255.255.0

Interface port3 (router3)

Administrative Distance 40

6. Go to Network > Interfaces.
7. Edit port 1 (internal) interface.
8. Set the following information and select OK.

Alias internal

IP/Network Mask 10.14.101.104/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Internal accounting network

Interface State Enabled

9. Edit port 2 (router2) interface.
10. Set the following information and select OK.

Alias router2

IP/Network Mask 10.14.201.104/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to R&D network & Internet through Router2

Interface State Enabled

11. Edit port 3 (router3) interface.
12. Set the following information and select OK.
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Alias router3

IP/Network Mask 10.14.301.104/255.255.255.0

Administrative Access HTTPS SSH PING

Comments Link to R&D network and Internet through Router3

Interface State Enabled

To configure Router4 system information - CLI

config system global
set hostname Router4

end
config router static

edit 1
set device "port2"
set distance 45
set gateway 10.14.201.102

next
edit 2

set device "port3"
set distance 45
set gateway 10.14.202.103

end
end
config system interface

edit port1
set alias internal
set ip 10.14.101.104/255.255.255.0
set allowaccess https ssh ping
set description "Internal sales network"

next
edit port2

set alias router2
set allowaccess https ssh ping
set ip 10.14.201.104/255.255.255.0
set description "Link to R&D network & Internet through Router2"

next
edit port3

set alias router3
set ip 10.14.202.104/255.255.255.0
set allowaccess https ssh ping
set description "Link to R&D network & Internet through Router2"

end
end

Configuring FortiGate unit RIP router information

With the interfaces configured, RIP can now be configured on the FortiGate units.

For each FortiGate unit, the following steps will be taken:
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l Configure RIP version used
l Redistribute static networks
l Add networks serviced by RIP
l Add interfaces that support RIP on the FortiGate unit

Router1 and Router4 are configured the same. Router2 and Router3 are configured the same. These routers will
be grouped accordingly for the following procedures. Repeat the procedures once for each FortiGate unit.

Configure RIP settings on Router1 and Router4 - web-based manager

1. Go to Network > RIP.
2. Select 2 for Version.
3. In Advanced Options, underRedistribute enable Static. Leave the other advanced options at their default

values.
4. UnderNetworks, add the following networks:

l 10.11.0.0/255.255.0.0
l 10.12.0.0/255.255.0.0
l 10.14.0.0/255.255.0.0
l 172.20.120.0/255.255.255.0

6. Under Interfaces, select Create New and set the following information:

Interface port1 (internal)

Passive disabled

Authentication None

Send Version Both

Receive Version Both

7. Under Interfaces select Create Newand set the following information:

Interface port2 (router2)

Passive disabled

Authentication None

Send Version Both

Receive Version Both

8. Under Interfaces, select Create Newand set the following information:

Interface port3 (router3)

Passive disabled
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Authentication None

Send Version Both

Receive Version Both

Configure RIP settings on Router1 and Router4 - CLI

config router rip
set version 2
config interface

edit "port1"
set receive-version 1 2
set send-version 1 2

next
edit "port2"

set receive-version 1 2
set send-version 1 2

next
edit "port3"

set receive-version 1 2
set send-version 1 2

end
config network

edit 1
set prefix 10.11.0.0 255.255.0.0

next
edit 2

set prefix 10.12.0.0 255.255.0.0
next
edit 3

set prefix 10.14.0.0 255.255.0.0
next
edit 4

set prefix 172.20.120.0 255.255.255.0
end

config redistribute "static"
set status enable

end
end

Configure RIP settings on Router2 and Router3 - web-based manager

1. Go to Network > RIP.
2. Select 2 forRIP.
3. In Advanced Options, underRedistribute enable Static. Leave the other advanced options at their default

values.
4. UnderNetworks, add the following networks:

l 10.11.0.0/255.255.0.0
l 10.12.0.0/255.255.0.0
l 10.14.0.0/255.255.0.0
l 172.20.120.0/255.255.255.0
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6. Under Interfaces, select Create New and set the following information:

Interface port1 (internal)

Passive disabled

Authentication None

Send Version Both

Receive Version Both

7. Under Interfaces, select Create New and set the following information:

Interface port2 (router1)

Passive disabled

Authentication None

Send Version Both

Receive Version Both

8. Under Interfaces, select Create New and set the following information:

Interface port3 (router4)

Passive disabled

Authentication None

Send Version Both

Receive Version Both

9. Under Interfaces, select Create New and set the following information:

Interface port4 (ISP)

Passive disabled

Authentication None

Send Version Both

Receive Version Both

Configure RIP settings on Router2 and Router3 - web-based manager

config router rip
set version 2
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config interface
edit "port1"

set receive-version 1 2
set send-version 1 2

next
edit "port2"

set receive-version 1 2
set send-version 1 2

next
edit "port3"

set receive-version 1 2
set send-version 1 2

end
edit "port4"

set receive-version 1 2
set send-version 1 2

end
config network

edit 1
set prefix 10.11.0.0 255.255.0.0

next
edit 2

set prefix 10.12.0.0 255.255.0.0
next
edit 3

set prefix 10.14.0.0 255.255.0.0
next
edit 4

set prefix 172.20.120.0 255.255.255.0
end

config redistribute "static"
set status enable

end
end

Configuring other networking devices

In this example, there are two groups of other devices on the the network: internal devices and the ISP.

The first is the internal network devices on the Sales, R&D, and Accounting networks. This includes simple static
routers, computers, printers, and other network devices. Once the FortiGate units are configured, the internal
static routers need to be configured using the internal network IP addresses. Otherwise, there should be no
configuration required.

The second group of devices is the ISP. This consists of the RIP router the FortiGate Router2 and Router3
connect to. You need to contact your ISP and ensure they have your information for your network, such as the IP
addresses of the connecting RIP routers, what version of RIP your network supports, and what authentication (if
any) is used.

Testing network configuration

Once the network has been configured, you need to test that it works as expected.

The two series of tests you need to run are to test the internal networks can communicate with each other, and
that the internal networks can reach the Internet.

Use ping, traceroute, and other networking tools to run these tests.
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If you encounter problems, for troubleshooting help consult Simple RIP example on page 2534.

IPsec auto discovery support

The following routing settings are available in the CLI to support IPsec auto discovery. They are designed for:

l Supporting the RIPng (RIP next generation) network command
l Limiting the maximum metric allowed to output for RIPng
l Fix NSM missing kernel address update information

The actual new settings are:

config router rip
set max-out-metric <integer value 1 - 15>
end

config router ripng
set max-out-metric <integer value 1 - 15>
end

config router ripng
config network

edit <ID # of network>
set prefix <IPv6 prefix>
end

end

RIPng: RIP and IPv6
RIP next generation, or RIPng, is the version of RIP that supports IPv6.

This is an example of a typical small network configuration using RIPng routing.

Your internal R&D network is working on a project for a large international telecom company that uses IPv6. For
this reason, you have to run IPv6 on your internal network and you have decided to use only IPv6 addresses.

Your network has two FortiGate units running the RIPng dynamic routing protocol. Both FortiGate units are
connected to the ISP router and the internal network. This configuration provides some redundancy for the R&D
internal network, allowing it to reach the Internet at all times.

Network layout and assumptions

Basic network layout

Your internal R&D network is working on a project for a large international telecom company that uses IPv6. For
this reason, you have to run IPv6 on your internal network and you have decided to use only IPv6 addresses.

Your network has two FortiGate units running the RIPng dynamic routing protocol. Both FortiGate units are
connected to the ISP router and the internal network. This configuration provides some redundancy for the R&D
internal network, allowing it to reach the Internet at all times.

All internal computers use RIP routing, so no static routing is required. And all internal computers use IPv6
addresses.

Where possible in this example, the default values will be used (or the most general settings). This is intended to
provide an easier configuration that will require less troubleshooting.
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In this example, the routers, networks, interfaces used, and IP addresses are as follows.

RIP example network topology

Network Router Interface & alias IPv6 address

R&D

Router1
port1 (internal) 2002:A0B:6565:0:0:0:0:0

port2 (ISP) 2002:AC14:7865:0:0:0:0:0

Router2
port1 (internal) 2002:A0B:6566:0:0:0:0:0

port2 (ISP) 2002:AC14:7866:0:0:0:0:0

Network topology for the IPV6 RIPng example

Assumptions

The following assumptions have been made concerning this example.

l All FortiGate units have 5.0 firmware and are running factory default settings.
l All CLI and web-based manager navigation assumes the unit is running in NAT operating mode, with VDOMs

disabled.
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l All FortiGate units have interfaces labeled port1 and port2, as required.
l All firewalls have been configured for each FortiGate unit to allow the required traffic to flow across interfaces.
l All network devices support IPv6 and are running RIPng.

Configuring the FortiGate units system information

Each FortiGate unit needs IPv6 enabled, a new hostname, and interfaces configured.

To configure system information on Router1 - web-based manager

1. Go to System > Dashboard > Status.
2. ForHost name, select Change.
3. Enter “Router1”.
4. Go to System > Config > Features.
5. In Basic Features, enable IPv6, and select Apply.
6. Go to System > Network > Interfaces.
7. Edit port1 (internal) interface.
8. Set the following information and select OK.

Alias internal

IP/Network Mask 2002:A0B:6565::/0

Administrative Access HTTPS SSH PING

Description Internal RnD network

Administrative Status Up

9. Edit port2 (ISP) interface.
10. Set the following information and select OK.

Alias ISP

IP/Network Mask 2002:AC14:7865::/0

Administrative Access HTTPS SSH PING

Description ISP and Internet

Administrative Status Up

To configure system information on Router1 - CLI

config system global
set hostname Router1
set gui-ipv6 enable

end
config system interface

edit port1
set alias internal

2552 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



RIP

set allowaccess https ping ssh
set description “Internal RnD network”
config ipv6

set ip6-address 2002:a0b:6565::/0
end

next
edit port2

set alias ISP
set allowaccess https ping ssh
set description “ISP and Internet”
config ipv6

set ip6-address 2002:AC14:7865::
end

end

To configure system information on Router2 - web-based manager

1. Go to System > Dashboard > Status.
2. ForHost name, select Change.
3. Enter “Router2”.
4. Go to System > Config > Features.
5. In Basic Features, enable IPv6, and select Apply.
6. Go to System > Network > Interfaces.
7. Edit port1 (internal) interface.
8. Set the following information and select OK.

Alias internal

IP/Network Mask 2002:A0B:6566::/0

Administrative Access HTTPS SSH PING

Description Internal RnD network

Administrative Status Up

9. Edit port2 (ISP) interface.
10. Set the following information and select OK.

Alias ISP

IP/Network Mask 2002:AC14:7866::/0

Administrative Access HTTPS SSH PING

Description ISP and Internet

Administrative Status Up

To configure system information on Router2 - CLI

config system global
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set hostname Router2
set gui-ipv6 enable

end
config system interface

edit port1
set alias internal
set allowaccess https ping ssh
set description “Internal RnD network”
config ipv6

set ip6-address 2002:a0b:6566::/0
end

next
edit port2

set alias ISP
set allowaccess https ping ssh
set description “ISP and Internet”
config ipv6

set ip6-address 2002:AC14:7866::
end

end

Configuring RIPng on FortiGate units

Now that the interfaces are configured, you can configure RIPng on the FortiGate units.

There are only two networks and two interfaces to include: the internal network and the ISP network. There is no
redistribution and no authentication. In RIPng there is no specific command to include a subnet in the RIP
broadcasts. There is also no information required for the interfaces beyond including their name.

As this is a CLI only configuration, configure the ISP router and the other FortiGate unit as neighbors. This was
not part of the previous example as this feature is not offered in the web-based manager. Declaring neighbors in
the configuration like this will reduce the discovery traffic when the routers start up.

Since RIPng is not supported in the web-based manager, this section will only be entered in the CLI.

To configure RIPng on Router1 - CLI

config router ripng
config interface

edit port1
next
edit port2
end

config neighbor
edit 1

set interface port1
set ipv6 2002:a0b:6566::/0

next
edit 2

set interface port2
set ipv6 2002:AC14:7805::/0

end

To configure RIPng on Router2 - CLI

config router ripng
config interface
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edit port1
next
edit port2
end

config neighbor
edit 1

set interface port1
set ipv6 2002:a0b:6565::/0

next
edit 2

set interface port2
set ipv6 2002:AC14:7805::/0

end

Configuring other network devices

The other devices on the internal network all support IPv6 and are running RIPng, where applicable. They only
need to know the internal interface network addresses of the FortiGate units.

The ISP routers need to know the FortiGate unit information, such as IPv6 addresses.

Testing the configuration

In addition to normal testing of your network configuration, you must also test the IPv6 part of this example.

For troubleshooting problems with your network, see the FortiOS Handbook Troubleshooting chapter.

For troubleshooting problems with RIP, see RIPng: RIP and IPv6 on page 2550.

Testing the IPv6 RIPng information

There are some commands to use when checking that your RIPng information is correct on your network. These
are useful to check on your RIPng FortiGate units on your network. Comparing the output between devices will
help you understand your network better, and also track down any problems:

diagnose ipv6 address list

View the local scope IPv6 addresses used as next-hops by RIPng on the FortiGate unit:

diagnose ipv6 route list

View ipv6 addresses that are installed in the routing table:

get router info6 routing-table

View the routing table. This information is almost the same as the previous diagnose ipv6 route list
command, but it is presented in a format that is easier to read.

get router info6 rip interface external

View the brief output on the RIP information for the interface listed. This includes information such as, if the
interface is up or down, what routing protocol is being used, and whether passive interface or split horizon are
enabled.

get router info6 neighbor-cache list
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View the IPv6/MAC address mapping. This also displays the interface index and name associated with the
address.
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OSPF

This section describes Open Shortest Path First (OSPF) routing.

OSPF background and concepts
Open Shortest Path First (OSPF) is a link-state interior routing protocol that is widely used in large enterprise
organizations. It only routes packets within a single autonomous system (AS). This is different from BGP,
because BGP can communicate between ASs

Background

OSPF version 2 (OSPFv2) was defined in 1998 in RFC 2328. OSPF was designed to support classless IP
addressing and variable subnet masks. This was a shortcoming of the earlier RIP protocols.

Updates to OSPFv2 are included in OSPF version 3 (OSPFv3), defined in 2008 in RFC 5340. OSPFv3 includes
support for IPv6 addressing, where OSPF2 only supports IPv4 addressing.

The main benefit of OSPF is that it detects link failures in the network quickly and within seconds, has converged
network traffic successfully without any networking loops. Also, OSPF has many features to control which routes
are propagated and which are not, maintaining smaller routing tables. OSPF can also provide better load-
balancing on external links than other interior routing protocols.

The parts and terminology of OSPF

The parts and terminology of OSPF include the following sections.

OSPFv3 and IPv6

OSPF version 3 (OSPFv3) includes support for IPv6, configurable from the CLI only. Generally, all IP addresses
are in IPv6 format instead of IPv4. However, OSPFv3 area numbers use the same 32-bit numbering system as
OSPFv2, as described in RFC 2740. Likewise, the router ID and area ID are in the same format as OSPFv2.

For IPv6, the main difference in OSPFv3 is that rather than using a network statement to enable OSPFv3 on an
interface, you define OSPF6 (OSPF for IPv6) interfaces, which are bound to the interface and area. This
configuration must be done in the CLI, as follows (with sample interfaces and addresses):

config router ospf6
config area

edit 0.0.0.0
next

end
config ospf6-interface

edit "tunnel"
set interface "to_FGT300A-7"

next
edit "internal_lan"
set interface "port1"

next
set router-id 10.174.0.113

end
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Note that OSPFv3 neighbors use link-local IPv6 addresses, but with broadcast and point-to-point network types,
and neighbors are automatically discovered.  You only have to manually configure neighbors when using non-
broadcast network types.

Router ID

In OSPF, each router has a unique 32-bit number that is called its router ID. Often, this 32-bit number is written
the same as a 32-bit IPv4 address would be written in dotted decimal notation. However, some brands of routers,
such as Cisco routers, support a router ID entered as an integer instead of an IP address.

It is a good idea not to use an IP address for the router ID that is already in use on the router. The router ID does
not have to be a particular IP address on the router. By choosing a different number, it will be harder to get
confused about which number you are looking at. It is a good idea to use as many of the area's numbers as
possible. For example, if you have 15 routers in area 0.0.0.0, they could be numbered from 0.0.0.1 to 0.0.0.15. If
you have an area 1.1.1.1, then routers in that area could start at 1.1.1.10.

You can manually set the router ID on your FortiGate unit:

To manually set an OSPF router ID of 0.0.1.1 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. ForRouter ID, enter 0.0.1.1.
3. Select Apply.

To manually set an OSPF router ID of 0.0.1.1 - CLI

config router ospf
set router-id 0.0.1.1

end

Adjacency

In an OSPF routing network, an OSPF router sends out OSPF hello packets when it boots up, to try to find any
neighbours (routers that have access to the same network as the router booting up). Once neighbors are
discovered and Hello packets are exchanged, updates are sent and the link state databases of both neighbors are
synchronized. At this point, these neighbors are said to be adjacent.

For two OSPF routers to become neighbors, the following conditions must be met:

l The subnet mask used on both routers must be the same subnet.
l The subnet number derived using the subnet mask and each router's interface IP address must match.
l The hello interval and the dead interval must match.
l The routers must have the same OSPF area ID. If they are in different areas, they are not neighbors.
l If authentication is used, they must pass authentication checks.

If any of these parameters are different between the two routers, the routers do not become OSPF neighbors and
cannot be adjacent. If the routers become neighbors, they are adjacent.

Adjacency and neighbors

Neighbor routers can be in a two-way state, and not be adjacent. Adjacent routers normally have a neighbor state
of FULL. Neighbors only exchange hello packets and do not exchange routing updates. Adjacent routers
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exchange LSAs (LSDB information) as well as hello packets. A good example of an adjacent pair of routers is the
designated router (DR) and backup designated router (BDR).

You can check on the state of an OSPF neighbor using the CLI get router info ospf neighbor all
command. For for more information, see OSPF background and concepts on page 2557.

Why adjacency is important

It is important to have adjacent pairs of routers in the OSPF routing domain because routing protocol packets are
only passed between adjacent routers. This means adjacency is required for two OSPF routers to exchange
routes.

If there is no adjacency between two routers, such as one on the 172.20.120.0 network and another on the
10.11.101.0 network, the routers do not exchange routes. This makes sense because if all OSPF routers on the
OSPF domain exchanged updates, it would flood the network.

Also, it is better for updates to progress through adjacent routers to ensure there are no outages along the way.
Otherwise, updates could skip over routers that are potentially offline, causing longer routing outages and delays,
while the OSPF domain learns of this outage later on.

If the OSPF network has multiple border routers and multiple connections to external networks, the designated
router (DR) determines which router pairs become adjacent. The DR can accomplish this because it maintains
the complete topology of the OSPF domain, including which router pairs are adjacent.

The backup designated router (BDR) also has this information in case the DR goes offline.

Designated router and backup router

In OSPF, a router can have a number of different roles to play.

A designated router (DR) is the designated broadcasting router interface for an AS. It looks after all of the initial
contact and other routing administration traffic. Having only one router do all of this this greatly reduces the
network traffic and collisions.

If something happens and the designated router goes offline, the backup designated router (BDR) takes over. An
OSPF FortiGate unit interface can become either a DR or BDR. Both the DR and the BDR cover the same area,
and are elected at the same time. The election process does not have many rules, but the exceptions can
become complex.

Benefits

The OSPF concept of the designated router is a big step above RIP. With all RIP routers doing their own updates
all the time, RIP suffers from frequent and sometimes unnecessary updates that can slow down your network.
With OSPF, not only do routing changes only happen when a link state changes instead of any tiny change to the
routing table, but the designated router reduces this overhead traffic even more.

However, smaller network topologies may have only a couple of routers besides the designated router. This may
seem excessive, but it maintains the proper OSPF form and it will still reduce the administration traffic, but to a
lesser extent than on a large network. Also, your network topology will be ready whenever you choose to expand
your network.

DR and BDR election

An election chooses DR and BDR from all the available routers. The election is primarily based on the priority
setting of the routers, where the highest priority becomes the DR and the second highest becomes the BDR. To
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resolve any ties, the router with the highest router ID wins. For example, a router with a router ID of 192.168.0.1
would win over a router with a router ID of 10.1.1.2.

The router priority can vary from 0 to 255, but at 0 a router will never become a DR or BDR. If a router with a
higher priority comes online after the election, it must wait until the DR and BDR go offline before it becomes the
DR.

If the original DR goes offline, but is then available when the BDR goes offline later on, the original DR will be
promoted back to DR without an election leaving the new BDR as it is.

With your FortiGate unit, to configure the port1 interface to be a potential OSPF DR or BDR called ospf_DR on
the network, you need to raise the priority of the router to a very high number, such as 250 out of 255. This will
ensure the interface has a chance to be a DR, but will not guarantee that it will be one. To help ensure it becomes
a DR, you should give the interface a low numbered IP address, such as 10.1.1.1 instead of 192.168.1.1 (but that
is not part of this example). Enter the following command:

config router ospf
config ospf-interface
edit "ospf_DR"

set priority 250
end

end

Area

An OSPF area is a smaller part of the larger OSPF AS. Areas are used to limit the link state updates that are sent
out. The flooding used for these updates would overwhelm a large network, so it is divided into these smaller
areas for manageability.

If there are two or more routers that are viable within an area, there will always be a designated router (DR) and a
backup designated router (BDR). For more information about these router roles, see Designated router and
backup router on page 2559.

Defining a private OSPF area involves the following:

l Assigning a 32-bit number to the area that is unique on your network
l Defining the characteristics of one or more OSPF areas
l Creating associations between the OSPF areas that you defined and the local networks to include in the OSPF area
l Adjusting the settings of OSPF-enabled interfaces, if required

IPv6 OSPF area numbers use the same 32-bit number notation as IPv4 OSPF.

If you are using the web-based manager to perform these tasks, follow the procedures summarized below.

FortiGate units support the four main types of OSPF areas:

l Backbone area
l Stub area
l NSSA
l Regular area
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Backbone area

Every OSPF network has at least one AS, and every OSPF network has a backbone area. The backbone is the
main area, and possibly the only area. All other OSPF areas are connected to a backbone area. This means if two
areas want to pass routing information back and forth, that routing information will go through the backbone on its
way between those areas. For this reason, the backbone not only has to connect to all other areas in the network,
but also has to be uninterrupted in order to be able to pass traffic to all points of the network.

The backbone area is referred to as area 0 because it has an IP address of 0.0.0.0.

Stub area

A stub area is an OSPF area that receives no outside routes advertised into it. All routing in it is based on a
default route. This essentially isolates it from outside areas.

Stub areas are useful for small networks that are part of a larger organization, especially if the networking
equipment cannot handle routing large amounts of traffic passing through, or if there are other reasons to prevent
outside traffic, such as security. For example, most organizations do not want their accounting department to be
the center of their network with everyone’s traffic passing through there. It would increase the security risks, slow
down their network, and it generally does not make sense.

A variation on the stub area is the totally stubby area. It is a stub area that does not allow summarized routes.

NSSA

A not-so-stubby-area (NSSA) is a stub area that allows for external routes to be injected into it. While it still does
not allow routes from external areas, it is not limited to using only the default route for internal routing.

Regular area

A regular area is what all the other ASs are, all the non-backbone, non-stub, and non-NSSA areas. A regular area
generally has a connection to the backbone, does receive advertisements of outside routes, and does not have an
area number of 0.0.0.0.

Authentication

In the OSPF packet header, there are two authentication-related fields: AuType and Authentication.

All OSPF packet traffic is authenticated. Multiple types of authentication are supported in OSPFv2. However in
OSPFv3, there is no authentication built-in but it is assumed that IPsec will be used for authentication instead.

Packets that fail authentication are discarded.

Null authentication

Null authentication indicates there is no authentication being used. In this case, the 16-byte authentication field is
not checked, and can be any value. However, checksumming is still used to locate errors. On your FortiGate, this
is the none option for authentication.

Simple password authentication

Simple password refers to a standard plain text string of characters. The same password is used for all
transactions on a network. The main use for this type of authentication is to prevent routers from accidently

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2561



OSPF

joining the network. Simple password authentication is vulnerable to many forms of attack, and is not
recommended as a secure form of authentication.

Cryptographic authentication

Cryptographic authentication involves the use of a shared secret key to authenticate all router traffic on a
network. The key is never sent over the network in the clear. A packet is sent and a condensed and encrypted
form of the packet is appended to the end of the packet. A non-repeating sequence number is included in the
OSPF packet to protect against replay attacks that could try to use already sent packets to disrupt the network.
When a packet is accepted as authentic, the authentication sequence number is set to the packet sequence
number. If a replay attack is attempted, the packet sent will be out of sequence and ignored.

Your FortiGate unit supports all three levels of authentication through the authentication keyword associated with
creating an OSPF interface .

For example, to create an OSPF interface called Accounting on the port1 interface that is a broadcast
interface, has a hello interval of 10 seconds, has a dead interval of 40 seconds, uses text authentication (simple
password) with a password of “ospf_test”, enter the command:

config router ospf
config ospf-interface
edit Accounting

set interface port1
set network-type broadcast
set hello-interval 10
set dead-interval 40
set authentication text
set authentication-key "ospf_test"

end
end

Hello and dead intervals

The OSPF Hello protocol is used to discover and maintain communications with neighboring routers.

Hello packets are sent out at a regular interval for this purpose. The DR sends out the hello packets. In a
broadcast network, the multicast address of 224.0.0.5 is used to send out hello packets. New routers on the
network listen for and reply to these packets to join the OSPF area. If a new router never receives a hello packet,
other routers will not know it is there and will not communicate with it. However, once a new router is discovered,
the DR adds it to the list of routers in that area and it is integrated into the routing calculations.

Dead interval is the time other routers will wait before declaring a neighbor dead (offline). It is very important to
set a reasonable dead interval. If this interval is too short, routers will be declared offline when they are just slow
or momentarily inaccessible, and link state updates will happen more than they need to, using more bandwidth. If
the dead interval is too long, it will slow down network traffic overall if online routers attempt to contact offline
ones instead of re-routing traffic.

FortiOS also supports OSPF fast-hello, which provides a way to send multiple hello packets per second. This is
achieved by setting a dead-interval to one second. The hello-multiplier, which can be any number between 4 and
10, determines the number of hello packets that will be sent every second. The CLI syntax for OSPF fast-hello is
as follows:

config ospf-interface
edit ospf1

set interface port1
set network-type broadcast
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set dead-interval 1
set hello-multiplier 4

end

Access lists

Access lists are filters used by FortiGate unit OSPF routing. An access list provides a list of IP addresses and the
action to take for them. An access list essentially makes it easy to group addresses that will be treated the same
into the same group, independent of their subnets or other matching qualities. You add a rule for each address or
subnet that you want to include, specifying the action to take for it. For example, if you want all traffic from one
department to be routed a particular way, even in different buildings, you can add all the addresses to an access
list and then handle that list all at once.

Each rule in an access list consists of a prefix (IP address and netmask), the action to take for this prefix (permit or
deny), and whether to match the prefix exactly or to match the prefix and any more specific prefix.

The FortiGate unit attempts to match a packet against the rules in an access list, starting at the top of the list. If it
finds a match for the prefix, it takes the action specified for that prefix. If no match is found, the default action is
deny.

Access lists greatly speed up configuration and network management. When there is a problem, you can check
each list instead of individual addresses. It also eases troubleshooting because if all addresses on one list have
problems, it eliminates many possible causes right away.

If you are using the OSPF+ IPv6 protocols, you will need to use access-list6, the IPv6 version of access list. The
only difference is that access-list6 uses IPv6 addresses.

For example, if you want to create an access list called test_list that only allows an exact match of
10.10.10.10 and 11.11.11.11, enter the command:

config router access-list
edit test_list
config rule

edit 1
set prefix 10.10.10.10 255.255.255.255
set action allow
set exact-match enable

next
edit 2

set prefix 11.11.11.11 255.255.255.255
set action allow
set exact-match enable

end
end

Another example is if you want to deny ranges of addresses in IPv6 that start with the IPv6 equivalents of
10.10.10.10 and 11.11.11.11, enter the access-list6 command as follows:

config router access-list6
edit test_list_ip6

config rule
edit 1

set prefix6 2002:A0A:A0A:0:0:0:0:0:/48
set action deny

next
edit 2

set prefix6 2002:B0B:B0B:0:0:0:0:0/48
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set action deny
end

To use an access_list, you must call it from a routing protocol such as RIP. The following example uses the
access_list from the earlier example called test_list to match routes coming in on the port1 interface. When there
is a match, it will add 3 to the hop count metric for those routes to artificially decrease their priority. Enter the
following command:

config router ospf
config distribute-list

edit 5
set access-list test_list
set protocol connected

end

If you are setting a prefix of 128.0.0.0, use the format 128.0.0.0/1. The default route 0.0.0.0/0 cannot be exactly
matched with an access-list. A prefix-list must be used for this purpose.

How OSPF works

An OSPF installation consists of one or more areas. An OSPF area is typically divided into logical areas linked by
Area Border Routers (ABR). A group of contiguous networks form an area. An ABR links one or more areas to the
OSPF network backbone (area ID 0). For more information, see Dynamic routing overview on page 2503.

OSPF is an interior routing protocol. It includes a backbone AS and possibly additional ASs. The DR and BDR are
elected from potential routers with the highest priorities. The DR handles much of the administration to lower the
network traffic required. New routers are discovered through hello packets sent from the DR using the multicast
address of 224.0.0.5. If the DR goes offline at any time, the BDR has a complete table of routes that it uses when
it takes over as the DR router.

OSPF does not use UDP or TCP, but is encapsulated directly in IP datagrams as protocol 89. This is in contrast to
RIP and BGP. OSPF handles its own error detection and correction functions.

The OSPF protocol, when running on IPv4, can operate securely between routers, optionally using a variety of
authentication methods to allow only trusted routers to participate in routing. OSPFv3, running on IPv6, no longer
supports protocol-internal authentication. Instead, it relies on IPv6 protocol security (IPsec).

Other important parts of how OSPF works include:

l OSPF router discovery
l How OSPF works on FortiGate units
l External routes
l Link state database and route updates
l OSPF packets

OSPF router discovery

OSPF-enabled routers generate link state advertisements (LSA) and send them to their neighbors whenever the
status of a neighbor changes or a new neighbor comes online. As long as the OSPF network is stable, LSAs
between OSPF neighbors do not occur. An LSA identifies the interfaces of all OSPF-enabled routers in an area,
and provides information that enables OSPF-enabled routers to select the shortest path to a destination. All LSA
exchanges between OSPF-enabled routers are authenticated.

When a network of OSPF routers comes online, the following steps occur:
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1. When OSPF routers come online, they send out hello packets to find other OSPF routers on their network
segment.

2. When they discover other routers on their network segment, they generally become adjacent. Adjacent routers can
exchange routing updates. For more information, see Adjacency on page 2558.

3. ADR and BDR are elected from the available routers using priority settings and router ID. See Designated router
and backup router on page 2559, and OSPF background and concepts on page 2557.

4. Link state updates are sent between adjacent routers to map the topology of the OSPF area.
5. Once complete, the DR floods the network with the updates to ensure all OSPF routers in the area have the same

OSPF route database. After the initial update, there are very few required updates if the network is stable.

How OSPF works on FortiGate units

When a FortiGate unit interface is connected to an OSPF area, that unit can participate in OSPF
communications. FortiGate units use the OSPF hello protocol to acquire neighbors in an area. A neighbor is any
router that is directly connected to the same area as the FortiGate unit and ideally is adjacent with a state of Full.
After initial contact, the FortiGate unit exchanges hello packets with its OSPF neighbors regularly to confirm that
the neighbors can be reached.

The number of routes that a FortiGate unit can learn through OSPF depends on the network topology. A single
unit can support tens of thousands of routes if the OSPF network is configured properly.

External routes

OSPF is an internal routing protocol. OSPF external routes are routes where the destination is using a routing
protocol other than OSPF. OSPF handles external routes by adjusting the cost of the route to include the cost of
the other routing protocol. There are two methods of calculating this cost, which are used for OSPF external1 (E1)
and OSPF external2 (E2).

OSPF E1

In OSPF E1, the destination is outside the OSPF domain. This requires a different metric to be used beyond the
normal OSPF metrics. The new metric of a redistributed route is calculated by adding the external cost and the
OSPF cost together.

OSPF E2

OSPF E2 is the default external type when routes are redistributed outside of OSPF. With OSPF E2, the metric of
the redistributed route is equivalent to the external cost only, expressed as an OSPF cost. Dropping the OSPF
portion can be useful in a number of situations, for example, on border routers that have no OSPF portion or
where the OSPF routing cost is negligible compared to the external routing cost.

Comparing E1 and E2

The best way to understand OSPF E1 and E2 routes is to check routing tables on OSPF routers. If you look at the
routes on an OSPF border router, the redistributed routes will have an associated cost that represents only the
external route, as there is no OSPF cost to the route due to it already being on the edge of the OSPF domain.
However, if you look at that same route on a different OSPF router inside the OSPF routing domain, it will have a
higher associated cost, essentially the external cost plus the cost over the OSPF domain to that border router.
The border router uses OSPF E2, where the internal OSPF router uses OSPF E1 for the same route.
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Viewing external routes

When you are trying to determine the costs for routes in your network to predict how traffic will be routed, you
need to see the external OSPF routes and their associated costs. On your FortiGate unit, you find this
information through the CLI.

To view external routes - CLI

You can view the whole routing table using get router info routing-table all to see all the routes,
including the OSPF external routes. For a shorter list, you can use the get router info routing-table
ospf command. The letter at the left will be either E1 or E2 for external OSPF routes. The output will look similar
to the following, depending on what routes are in your routing table:

FGT620B# get router info routing-table all
Codes: K - kernel, C - connected, S - static, R - RIP, B - BGP
O - OSPF, IA - OSPF inter area
N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2
E1 - OSPF external type 1, E2 - OSPF external type 2
i - IS-IS, L1 - IS-IS level-1, L2 - IS-IS level-2, ia - IS-IS inter area
* - candidate default

O*E2   0.0.0.0/0 [110/10] via 10.1.1.3, tunnel_wan2, 00:02:11
O      10.0.0.1/32 [110/300] via 10.1.1.3, tunnel_wan2, 00:02:11
S      0.0.0.0/0 [10/0] via 192.168.183.254, port2
S      1.0.0.0/8 [10/0] via 192.168.183.254, port2

Link state database and route updates

OSPF is based on links. The links between adjacent neighbor routers allow updates to be passed along the
network. Network links allow the DR to flood the area with link state database (LSDB) updates. External links
allow the OSPF area to connect to destinations outside the OSPF autonomous system. Information about these
links is passed throughout the OSPF network as link state updates.

The LSDB contains the information that defines the complete OSPF area, but the LSDB is not the routing table. It
contains the information from all the link state updates passed along the network. When there are no more
changes required and the network is stable, the LSDB on each router in the network will be the same. The DR will
flood the LSDB to the area to ensure each router has the same LSDB.

To calculate the best route (shortest path) to a destination, the FortiGate unit applies the Shortest Path First
(SPF) algorithm, based on Dijkstra’s algorithm, to the accumulated link state information. OSPF uses relative
path cost metric for choosing the best route. The path cost can be any metric, but is typically the bandwidth of the
path, which is how fast traffic will get from one point to another.

The path cost, similar to “distance” for RIP, imposes a penalty on the outgoing direction of a FortiGate unit
interface. The path cost of a route is calculated by adding all of the costs associated with the outgoing interfaces
along the path to the destination. The lowest overall path cost indicates the best route, and generally the fastest
route. Some brands of OSPF routers, such as Cisco, implement cost as a direct result of bandwidth between the
routers. Generally this is a good cost metric because larger bandwidth means more traffic can travel without
slowing down. To achieve this type of cost metric on FortiGate units, you need to set the cost for each interface
manually in the CLI.

The inter-area routes may not be calculated when a Cisco type ABR has no fully adjacent neighbor in the
backbone area. In this situation, the router considers summary-LSAs from all Actively summary-LSAs from
all Actively Attached areas (RFC 3509).
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The FortiGate unit dynamically updates its routing table based on the results of the SPF calculation to ensure
that an OSPF packet will be routed using the shortest path to its destination. Depending on the network topology,
the entries in the FortiGate unit routing table may include:

l The addresses of networks in the local OSPF area (to which packets are sent directly)
l Routes to OSPF area border routers (to which packets destined for another area are sent)
l Routes to area boundary routers, if the network contains OSPF areas and non-OSPF domains, which reside on the

OSPF network backbone and are configured to forward packets to destinations outside the OSPF AS.

OSPF route updates

Once the OSPF domain is established, there should be few updates required on a stable network. When updates
occur and a decision is required concerning a new route, this is the general procedure.

Our router gets a new route and needs to decide if it should go in the routing table.

The router has an up-to-date LSDB of the entire area, containing information about each router, the next hop to
it, and most importantly the cost to get there.

Our router turns the LSDB into an SPF tree using Dijkstra’s algorithm. It does not matter if there is more than one
path to a router on the network, the SPF tree only cares about the shortest path to that router.

Once the SPF tree has been created and shows the shortest paths to all the OSPF routers on the network, the
work is done. If the new route is the best route, it will be part of that tree. If it is not the shortest route, it will not be
included in the LSDB.

If there has been a change from the initial LSDB to the new SPF tree, a link state update will be sent out to let the
other routers know about the change so they can also update their LSDBs. This is vital since all routers on the
OSPF area must have the same LSDB.

If there was no change between the LSDB and the SPF tree, no action is taken.

OSPF packets

Every OSPF packet starts with a standard 24-byte header, and another 24 bytes of information or more. The
header contains all the information necessary to determine whether the packet should be accepted for further
processing.

OSPF packet

1-byte Version field 1-byte Type field 2-byte Packet length 3-byte Router ID

4-byte Area ID 2-byte Checksum 2-byte Auth Type 8-byte Authentication

4-byte Network Mask 2-byte Hello interval 1-byte Options field 1-byte Router Priority

4-byte Dead Router
interval 4-byte DR field 4-byte BDR field 4-byte Neighbor ID

The following descriptions summarize the OSPF packet header fields:

Version field: The OSPF version number. This specification documents version 2 of the protocol.

Type field: There are 5 OSPF packet types. From one to five, respectively, they are Hello, Database Description,
Link State Request, Link State Update, and Link State Acknowledgment.
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Packet length: The length of the OSPF protocol packet, in bytes. This length includes the standard OSPF 24-
byte header, so all OSPF packets are at 24-bytes long.

Router ID: The Router ID of the packet's source.

Area ID: A 32-bit number identifying the area that this packet belongs to. All OSPF packets are associated with a
single area. Most travel a single hop only. Packets travelling over a virtual link are labelled with the backbone Area
ID of 0.0.0.0.

Checksum: The standard IP checksum of the entire contents of the packet, starting with the OSPF packet
header but excluding the 64-bit authentication field. This checksum is calculated as the 16-bit one's complement
of the one's complement sum of all the 16-bit words in the packet, excepting the authentication field. If the
packet's length is not an integral number of 16-bit words, the packet is padded with a byte of zero before
checksumming. The checksum is considered to be part of the packet authentication procedure. For some
authentication types, the checksum calculation is omitted.

Auth Type: Identifies the authentication procedure to be used for the packet. Authentication types include Null
authentication (0), Simple password (1), Cryptographic authentication (2), and all others are reserved for future
use.

Authentication: A 64-bit field for use by the authentication scheme. When AuType indicates no authentication is
being used, the authentication field is not checked and can be any value. When AuType is set to 2 (cryptographic
authentication), the 64-bit authentication field is split into the following four fields: Zero field, Key ID field,
Authentication data length field, and Cryptographic sequence field.

The Key ID field indicates the key and algorithm used to create the message digest appended to the packet. The
Authentication data length field indicates how many bytes long the message digest is. The Cryptographic
sequence field is a non-decreasing number that is set when the packet is received and authenticated to prevent
replay attacks.

Network Mask: The subnet where this packet is valid.

Hello interval: The period of time between sending out hello packets. For more information, see Hello and dead
intervals on page 2562.

Options field: The OSPF protocol defines several optional capabilities. A router indicates the optional
capabilities that it supports in its OSPF hello packets, database description packets and in its LSAs. This enables
routers supporting a mix of optional capabilities to coexist in a single AS.

Router priority: The priority, between 0 and 255, that determines which routers become the DR and BDR. For
more information, see Designated router and backup router on page 2559.

Dead router interval: The period of time when there is no response from a router before it is declared dead. For
more information, see Hello and dead intervals on page 2562.

DR and BDR fields: The DR and BDR fields each list the router that fills that role on this network, generally the
routers with the highest priorities. For more information, see Designated router and backup router on page 2559.

Neighbor ID: The ID number of a neighboring router. This ID is used to discover new routers and respond to
them.

Troubleshooting OSPF
As with other dynamic routing protocols, OSPF has some issues that may need troubleshooting from time to
time. For basic troubleshooting, see the FortiOS Handbook Troubleshooting chapter.
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Clearing OSPF routes from the routing table

If you think the wrong route has been added to your routing table and you want to check it out, you first have to
remove that route from your table before seeing if it is added back in or not. You can clear all or some OSPF
neighbor connections (sessions) using the execute router clear ospf command. The exec router clear
command is much more limiting for OSPF than it is for BGP. For more information, see BGP on page 2598.

For example, if you have routes in the OSPF routing table and you want to clear the specific route to IP address
10.10.10.1, you will have to clear all the OSPF entries. Enter the command:

execute router clear ospf process

Checking the state of OSPF neighbors

In OSPF, each router sends out link state advertisements to find other routers on its network segment and to
create adjacencies with some of those routers. This is important because routing updates are only passed
between adjacent routers. If two routers you believe to be adjacent are not, that can be the source of routing
failures.

To identify this problem, you need to check the state of the OSPF neighbors of your FortiGate unit. Use the CLI
get router info ospf neighbor all command to see all the neighbors for your FortiGate unit. You
will see output in the form of:

FGT1 # get router info ospf neighbor
OSPF process 0:
Neighbor ID  Pri  State Dead Time Address Interface
10.0.0.2     1    Full/ -  00:00:39 10.1.1.2 tunnel_wan1
10.0.0.2     1    Full/ -  00:00:34 10.1.1.4 tunnel_wan2

The important information here is the State column. Any neighbors that are not adjacent to your FortiGate unit
will be reported in this column as something other than Full. If the state is Down, that router is offline.

Passive interface problems

A passive OSPF interface does not send out any updates. This means it cannot be a DR, BDR, or an area border
router among other things. It will depend on other neighbor routers to update its link state table.

Passive interfaces can cause problems when they are not receiving the routing updates you expect from their
neighbors. This will result in the passive OSPF FortiGate unit interface having an incomplete or out-of-date link
state database, and it will not be able to properly route its traffic. It is possible that the passive interface is
causing a hole in the network where no routers are passing updates to each other, however, this is a rare
situation.

If a passive interface is causing problems, there are simple methods to determine it is the cause. The easiest
method is to make it an active interface, and if the issues disappear, then that was the cause. Another method is
to examine the OSPF routing table and related information to see if it is incomplete compared to other neighbor
routers. If this is the case, you can clear the routing table, reset the device, and allow it to repopulate the table.

If you cannot make the interface active for some reason, you will have to change your network to fix the “hole” by
adding more routers, or changing the relationship between the passive router’s neighbors to provide better
coverage.

Timer problems

A timer mismatch is when two routers have different values set for the same timer. For example, if one router
declares a router dead after 45 seconds and another waits for 4 minutes, that difference in time will result in those
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two routers being out of synch for that period of time. One will still see the offline router as being online.

The easiest method to check the timers is to check the configuration on each router. Another method is to sniff
some packets, and read the timer values in the packets themselves from different routers. Each packet contains
the hello interval and dead interval periods, so you can compare them easily enough.

BFD

Bidirectional Forwarding Detection (BFD) is a protocol used to quickly locate hardware failures in the network.
Routers running BFD communicate with each other and if a timer runs out on a connection then that router is
declared down. BFD then communicates this information to the routing protocol and the routing information is
updated.

Authentication issues

OSPF has a number of authentication methods you can choose from. You may encounter problems with routers
not authenticating as you expect. This will likely appear simply as one or more routers that have a blind spot in
their routing and they will not acknowledge a router. This can be a problem if that router connects areas to the
backbone, as it will appear to be offline and unusable.

To confirm this is the issue, the easiest method is to turn off authentication on the neighboring routers. With no
authentication between any routers, everything should flow normally.

Another method to confirm that authentication is the problem is to sniff packets and look at their contents. The
authentication type and password are right in the packets which makes it easy to confirm they are what you
expect during real time. It is possible one or more routers is not configured as you expect and may be using the
wrong authentication. This method is especially useful if there are a group of routers with these problems since it
may be only one router causing the problem that is seen in multiple routers.

Once you have confirmed the problem is related to authentication, you can decide how to handle it. You can turn
off authentication and take your time to determine how to get your preferred authentication type back online. You
can try another type of authentication, such as text instead of md5, which may have more success and still
provide some level of protection. The important part is that once you confirm the problem, you can decide how to
fix it properly.

DR and BDR election issues

You can force a particular router to become the DR and BDR by setting its priorities higher than any other OSPF
routers in the area. This is a good idea when those routers have more resources to handle the traffic and extra
work of the DR and BDR roles, since not all routers may be able to handle all of that traffic.

However, if you set all the other routers so they do not have a chance at being elected (give them a priority of 0),
you can run into problems if the DR and BDR go offline. The good part is that you will have some warning
generally as the DR goes offline and the BDR is promoted to the DR position. However, if the network segment
with both the DR and BDR goes down, your network will have no way to send hello packets, send updates, or
perform the other tasks that the DR performs.

The solution to this is to always allow routers to have a chance to be promoted, even if you set their priority to 1.
In that case, they will be the last choice but if there are no other candidates, you want that router to become the
DR. Most networks will have already alerted you to the equipment problems, so this will be a temporary measure
to keep the network traffic moving until you can find and fix the problem and get the real DR back online.
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Basic OSPF example
This example sets up an OSPF network at a small office. There are 3 routers, all running OSPFv2. The border
router connects to a BGP network.

All three routers in this example are FortiGate units. Router1 will be the designated router (DR) and Router2 will
be the backup designated router (BDR) due to their priorities. Router3 will not be considered for either the DR or
BDR elections. Instead, Router3 is the Autonomous System Border Router (ASBR) routing all traffic to the ISP’s
BGP router on its way to the Internet.

Router2 has a modem connected that provides dialup access to the Internet as well, at a reduced bandwidth.
This is a PPPoE connection to a DSL modem. This provides an alternate route to the Internet if the other route
goes down. The DSL connection is slow and is charged by the amount of traffic. For these reasons, OSPF will
highly favor Router3’s Internet access.

The DSL connection connects to an OSPF network with the ISP, so no redistribution of routes is required.
However, the ISP network does have to be added to that router’s configuration.

Network layout and assumptions

There are three FortiGate units acting as OSPFv2 routers on the network: Router1, Router2, and Router3.
Router1 will be the DR, and Router 2 the BDR. Router3 is the ASBR that connects to the external ISP router
running BGP. Router2 has a PPPoEDSL connection that can access the Internet.

The head office network is connected to Router1 and Router2 on the 10.11.101.0 subnet.

Router1 and Router3 are connected over the 10.11.103.0 subnet.

Router2 and Router3 are connected over the 10.11.102.0 subnet.

The following table lists the router, interface, address, and role it is assigned.

Routers, interfaces, and IP addresses for the basic OSPF example network

Router name Interface IP address Interface is connected to:

Router1 (DR) Internal (port1) 10.11.101.1 Head office network and Router2

External (port2) 10.11.102.1 Router3

Router2 (BDR) Internal (port1) 10.11.101.2 Head office network and Router1

External (port2) 10.11.103.2 Router3

DSL (port3) 10.12.101.2 PPPoEDSL access

Router3 (ASBR)

Internal1 (port1) 10.11.102.3 Router1

Internal2 (port2) 10.11.103.3 Router2

External (port3) 172.20.120.3 ISP’s BGP network
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Basic OSPF network topology

Note that other subnets can be added to the internal interfaces without changing the configuration.

Assumptions

l The FortiGate units used in this example have interfaces named port1, port2, and port3.
l All FortiGate units in this example have factory default configuration with FortiOS 4.0 MR2 firmware installed and

are in NAT operation mode.
l Basic firewalls are in place to allow unfiltered traffic between all connected interfaces in both directions.
l This OSPF network is not connected to any other OSPF networks.
l Both Internet connections are always available.
l The modem connection is very slow and expensive.
l Other devices may be on the network, but do not affect this basic configuration.
l Router3 is responsible for redistributing all routes into and out of the OSPF AS.

Configuring the FortiGate units

Each FortiGate unit needs the interfaces and basic system information, such as hostname, configured.

This section includes:

l Configuring Router1
l Configuring Router2
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l Configuring Router3

Configuring Router1

Router1 has two interfaces connected to the network: internal (port1) and external (port2). Its host name must be
changed to Router1.

To configure Router1 interfaces - web-based manager

1. Go to System > Dashboard > Status.
2. Beside the host name, select Change.
3. Enter a hostname of Router1 and select OK.
4. Go to Network > Interfaces, edit port1, set the following information, and select OK.

Alias internal

IP/Network Mask 10.11.101.1/255.255.255.0

Administrative Access HTTPS SSH PING

Description Head office and Router2

Administrative Status Up

5. Edit port2, set the following information and select OK.

Alias External

IP/Network Mask 10.11.102.1/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router3

Administrative Status Up

Configuring Router2

Router2 configuration is the same as Router1, except Router2 also has the DSL interface to configure.

The DSL interface is configured with a username of “user1” and a password of “ospf_example”. The default
gateway will be retrieved from the ISP and the defaults will be used for the rest of the PPPoE settings.

To configure Router2 interfaces - web-based manager

1. Go to System > Dashboard > Status.
2. Beside the host name, select Change.
3. Enter a hostname of Router2 and select OK.
4. Go to Network > Interfaces, edit port1, set the following information, and select OK.
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Alias internal

IP/Network Mask 10.11.101.2/255.255.255.0

Administrative Access HTTPS SSH PING

Description Head office and Router1

Administrative Status Up

5. Edit port2, set the following information and select OK.

Alias External

IP/Network Mask 10.11.103.2/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router3

Administrative Status Up

6. Edit DSL (port3), set the following information and select OK.

Alias DSL

Addressing Mode PPPoE

Username user1

Password ospf_example

Unnumbered IP 10.12.101.2/255.255.255.0

Retrieve default gateway from server Enable

Administrative Access HTTPS SSH PING

Description DSL

Administrative Status Up

Configuring Router3

Router3 is similar to Router1 and Router2 configurations. The main difference is the External (port3) interface
connected to the ISP BGP network, which has no administration access enabled for security reasons.

To configure Router3 interfaces - web-based manager

1. Go to System > Status > Dashboard.
2. Next to hostname, select Change.
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3. Enter a hostname of Router3 and select OK.
4. Go to Network > Interfaces, edit port1, set the following information, and select OK.

Alias internal

IP/Network Mask 10.11.102.3/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router1

Administrative Status Up

5. Edit port2, set the following information and select OK.

Alias Internal2

IP/Network Mask 10.11.103.3/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router2

Administrative Status Up

6. Edit port3, set the following information and select OK.

Alias External

IP/Network Mask 172.20.120.3/255.255.255.0

Administrative Access HTTPS SSH PING

Description ISP BGP

Administrative Status Up

Configuring OSPF on the FortiGate units

With the interfaces configured, now the FortiGate units can be configured for OSPF on those interfaces. All
routers are part of the backbone 0.0.0.0 area, so there is no inter-area communications needed.

For a simple configuration, there will be no authentication, no graceful restart or other advanced features, and
timers will be left at their defaults. Also, the costs for all interfaces will be left at 10, except for the modem and
ISP interfaces where cost will be used to load balance traffic. Nearly all advanced features of OSPF are only
available from the CLI.

The network that is defined covers all the subnets used in this example - 10.11.101.0, 10.11.102.0, and
10.11.103.0. All routes for these subnets will be advertised. If there are other interfaces on the FortiGate units
that you do not want included in the OSPF routes, ensure those interfaces use a different subnet outside of the
10.11.0.0 network. If you want all interfaces to be advertised you can use an OSPF network of 0.0.0.0 .

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2575



OSPF

Each router will configure:

l Router ID
l Area
l Network
l Two or three interfaces depending on the router
l Priority for DR (Router1) and BDR (Router2)
l Redistribute for ASBR (Router3)

This section includes:

l Configuring OSPF on Router1
l Configuring OSPF on Router2
l Configuring OSPF on Router3

Configuring OSPF on Router1

Router1 has a very high priority to ensure it becomes the DR for this area. Also Router1 has the lowest IP address
to help ensure it will win in case there is a tie at some point. Otherwise, it is a standard OSPF configuration.
Setting the priority can only be done in the CLI, and it is for a specific OSPF interface.

To configure OSPF on Router1 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. Set Router ID to 10.11.101.1 and select Apply.
3. In Areas, select Create New, set the following information, and select OK.

Area 0.0.0.0

Type Regular

Authentication none

4. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.0.0/255.255.0.0

Area 0.0.0.0

5. In Interfaces, select Create New, set the following information, and select OK.

Name Router1-Internal-DR

Interface port1 (Internal)

IP 0.0.0.0

Authentication none
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Timers (seconds)

Hello Interval 10

Dead Interval 40

6. In Interfaces, select Create New, set the following information, and select OK.

Name Router1-External

Interface port2 (External)

IP 0.0.0.0

Authentication none

Timers (seconds)

Hello Interval 10

Dead Interval 40

7. Using the CLI, enter the following commands to set the priority for the Router1-Internal OSPF interface to
maximum, ensuring this interface becomes the DR.

config router ospf
config ospf-interface

edit Router1-Internal-DR
set priority 255

end

To configure OSPF on Router1 - CLI

config router ospf
set router-id 10.11.101.1
config area

edit 0.0.0.0
next

end
config network

edit 1
set prefix 10.11.0.0/255.255.255.0

next
end
config ospf-interface

edit "Router1-Internal"
set interface "port1"
set priority 255

next
edit "Router1-External"

set interface "port2"
next

end
end
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Configuring OSPF on Router2

Router2 has a high priority to ensure it becomes the BDR for this area and configures the DSL interface slightly
differently. Assume this will be a slower connection resulting in the need for longer timers and a higher cost for
this route.

Otherwise, it is a standard OSPF configuration.

To configure OSPF on Router2 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. Set Router ID to 10.11.101.2 and select Apply.
3. In Areas, select Create New, set the following information, and select OK.

Area 0.0.0.0

Type Regular

Authentication none

4. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.0.0/255.255.0.0

Area 0.0.0.0

5. In Interfaces, select Create New, set the following information, and select OK.

Name Router2-Internal

Interface port1 (Internal)

IP 0.0.0.0

Authentication none

Timers (seconds)

Hello Interval 10

Dead Interval

6. In Interfaces, select Create New, set the following information, and select OK.

Name Router2-External

Interface port2 (External)

IP 0.0.0.0
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Authentication none

Timers (seconds)

Hello Interval 10

Dead Interval 40

7. In Interfaces, select Create New, set the following information, and select OK.

Name Router2-DSL

Interface port3 (DSL)

IP 0.0.0.0

Authentication none

Cost 50

Timers (seconds)

Hello Interval 20

Dead Interval 80

8. Using the CLI, enter the following commands to set the priority for the Router2-Internal OSPF interface to ensure
this interface will become the BDR:

config router ospf
config ospf-interface

edit Router2-Internal
set priority 250

next
end

To configure OSPF on Router2 - CLI

config router ospf
set router-id 10.11.101.2
config area

edit 0.0.0.0
next

end
config network

edit 1
set prefix 10.11.0.0/255.255.0.0

next
end
config ospf-interface

edit "Router2-Internal"
set interface "port1"
set priority 255

next
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edit "Router2-External"
set interface "port2"

next
edit "Router2-DSL"

set interface "port3"
set cost 50

next
end

end

Configuring OSPF on Router3

Router3 is more complex than the other two routers. The interfaces are straightforward, but this router has to
import and export routes between OSPF and BGP. That requirement makes Router3 an ASBR. Also, Router3
needs a lower cost on its route to encourage all traffic to the Internet to route through it.

In the advanced OSPF options, redistribute is enabled for Router3. It allows different types of routes, learned
outside of OSPF, to be used in OSPF. Different metrics are assigned to these other types of routes to make them
more or less preferred to regular OSPF routes.

To configure OSPF on Router3 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. Set Router ID to 10.11.101.2 and select Apply.
3. Expand Advanced Options.
4. In Redistribute, set the following information, and select OK.

Route type Redistribute Metric

Connected Enable 15

Static Enable 15

RIP Disable n/a

BGP Enable 5

5. In Areas, select Create New, set the following information, and select OK.

Area 0.0.0.0

Type Regular

Authentication none

6. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.0.0/255.255.0.0

Area 0.0.0.0

7. In Interfaces, select Create New, set the following information, and select OK.
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Name Router3-Internal

Interface port1 (Internal)

IP 0.0.0.0

Authentication none

Timers (seconds)

Hello Interval 10

Dead Interval 40

8. In Interfaces, select Create New, set the following information, and select OK.

Name Router3-Internal2

Interface port2 (Internal2)

IP 0.0.0.0

Authentication none

Timers (seconds)

Hello Interval 10

Dead Interval 40

9. In Interfaces, select Create New, set the following information, and select OK.

Name Router3-ISP-BGP

Interface port3 (ISP-BGP)

IP 0.0.0.0

Authentication none

Cost 2

Timers (seconds)

Hello Interval 20

Dead Interval 80

10. Using the CLI, enter the following commands to set the priority for the Router3-Internal OSPF interface to ensure
this interface will become the BDR.

config router ospf

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2581



OSPF

config ospf-interface
edit Router3-Internal

set priority 250
next

end

To configure OSPF on Router3 - CLI

config router ospf
set router-id 10.11.102.3
config area

edit 0.0.0.0
next

end
config network

edit 1
set prefix 10.11.0.0/255.255.255.0

next
edit 2

set prefix 172.20.120.0/255.255.255.0
next

end
config ospf-interface

edit "Router3-Internal"
set interface "port1"
set priority 255

next
edit "Router3-External"

set interface "port2"
next
edit "Router3-ISP-BGP"

set interface "port3"
set cost 2

next
end

end

Configuring other networking devices

The other networking devices required in this configuration are on the two ISP networks, the BGP network for the
main Internet connection, and the DSL backup connection.

In both cases, the ISPs need to be notified about the OSPF network settings including router IP addresses, timer
settings, and so on. The ISP will use this information to configure its routers that connect to this OSPF network.

Testing network configuration

Testing the network configuration involves two parts: testing the network connectivity and testing the OSPF
routing.

To test the network connectivity, use ping, traceroute, and other network tools.

To test the OSPF routing in this example, refer to the troubleshooting outlined in Basic OSPF example on page
2571.
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Advanced inter-area OSPF example
This example sets up an OSPF network at a large office. There are three areas, each with two routers. Typically
OSPF areas would not be this small, and if they were, the areas would be combined into one larger area.
However, the stub area services the accounting department whose members are very sensitive about their
network and do not want their network information broadcasted through the rest of the company. The backbone
area contains the bulk of the company's network devices. The regular area was established for various reasons,
such as hosting the company servers in a separate area with extra security.

One area is a small stub area that has no independent Internet connection, and has only one connection to the
backbone area. That connection between the stub area and the backbone area is only through a default route. No
routes outside the stub area are advertised into that area. Another area is the backbone, which is connected to
the other two areas. The third area has the Internet connection, and all traffic to and from the Internet must use
that area’s connection. If that traffic comes from the stub area, then that traffic is treating the backbone like a
transit area that only uses it to get to another area.

In the stub area, a subnet of computers is running the RIP routing protocol and those routes must be redistributed
into the OSPF areas.

Network layout and assumptions

There are four FortiGate units in this network topology, which are acting as OSPF routers:
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Advanced inter-area OSPF network topology

Area 1.1.1.1 is a stub area with one FortiGate unit OSPF router called Router1 (DR). Its only access outside of
that area is a default route to the backbone area, which is how it accesses the Internet. Traffic must go from the
stub area, through the backbone, to the third area to reach the Internet. The backbone area in this configuration
is called a transit area. Also, in area 1.1.1.1 there is a RIP router that will be providing routes to the OSPF area
through redistribution.

Area 0.0.0.0 is the backbone area and has two FortiGate unit routers named Router2 (BDR) and Router3 (DR).

Area 2.2.2.2 is a regular area that has an Internet connection accessed by both the other two OSPF areas. There
is only one FortiGate unit router in this area called Router4 (DR). This area is more secure and requires MD5
authentication by routers.

All areas have user networks connected but they are not important for configuring the network layout for this
example.

Internal interfaces are connected to internal user networks only. External1 interfaces are connected to the
10.11.110.0 network, joining Area 1.1.1.1 and Area 0.0.0.0.

External2 interfaces are connected to the 10.11.111.0 network, joining Area 0.0.0.0 and Area 2.2.2.2. The ISP
interface is called ISP.
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Routers, areas, interfaces, and IP addresses for advanced OSPF network

Router name Area number and type Interface IP address

Router1 (DR) 1.1.1.1 - stub area
(Accounting)

port1 (internal) 10.11.101.1

port2 (external1) 10.11.110.1

Router2 (BDR) 0.0.0.0 - backbone area
( R&D Network)

port1 (internal) 10.11.102.2

port2 (external1) 10.11.110.2

port3 (external2) 10.11.111.2

Router3 (DR) 0.0.0.0 - backbone area
(R&D Network)

port1 (internal) 10.11.103.3

port2 (external1) 10.11.110.3

port3 (external2) 10.11.111.3

Router4 (DR) 2.2.2.2 - regular area
(Network Admin)

port1 (internal) 10.11.104.4

port2 (external2) 10.11.111.4

port3 (ISP) 172.20.120.4

Note that other subnets can be added to the internal interfaces without changing the configuration.

Assumptions

l The FortiGate units used in this example have interfaces named port1, port2, and port3.
l All FortiGate units in this example have factory default configuration with FortiOS 4.0 MR2 firmware installed and

are in NAT operation mode.
l During configuration, if settings are not directly referred to, they will be left at the default settings.
l Basic firewalls are in place to allow unfiltered traffic between all connected interfaces in both directions.
l This OSPF network is not connected to any other OSPF areas outside of this example.
l The Internet connection is always available.
l Other devices may be on the network but do not affect this configuration.

Configuring the FortiGate units

This section configures the basic settings on the FortiGate units to be OSPF routers. These configurations
include multiple interface settings and the hostname.

There are four FortiGate units in this example. The two units in the backbone area can be configured exactly the
same except for IP addresses, so only the Router3 (the DR) configuration will be given, with notes indicating
Router2's (the BDR) IP addresses.

Configuring the FortiGate units include:
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l Configuring Router1
l Configuring Router2
l Configuring Router3
l Configuring Router4

Configuring Router1

Router1 is part of the Accounting network stub area (1.1.1.1).

To configure Router1 interfaces - web-based manager

1. Go to System > Dashboard > Status.
2. Next to hostname, select Change.
3. Enter a hostname of Router1 and select OK.
4. Go to Network > Interfaces edit port1, set the following information, and select OK.

Alias internal

IP/Network Mask 10.11.101.1/255.255.255.0

Administrative Access HTTPS SSH PING

Description Accounting network

Administrative Status Up

5. Edit port2, set the following information and select OK.

Alias External1

IP/Network Mask 10.11.110.1/255.255.255.0

Administrative Access HTTPS SSH PING

Description Backbone network and Internet

Administrative Status Up

Configuring Router2

Router2 is part of the R&D network backbone area (0.0.0.0). Router2 and Router3 are in this area. They provide a
redundant connection between area 1.1.1.1 and area 2.2.2.2.

Router2 has three interfaces configured: one to the internal network and two to Router3 for redundancy.

To configure Router2 interfaces - web-based manager

1. Go to System > Dashboard > Status.
2. Next to hostname, select Change.
3. Enter a hostname of Router2 and select OK.
4. Go to Network > Interfaces, edit port1 (internal), set the following information, and select OK.
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Alias internal

IP/Network Mask 10.11.102.2/255.255.255.0

Administrative Access HTTPS SSH PING

Description Internal RnD network

Administrative Status Up

5. Edit port2 (external1), set the following information and select OK.

Alias external1

IP/Network Mask 10.11.110.2/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router3 first connection

Administrative Status Up

6. Edit port3 (external2), set the following information and select OK.

Alias external2

IP/Network Mask 10.11.111.2/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router3 second connection

Administrative Status Up

Configuring Router3

Router3 is part of the R&D network backbone area (0.0.0.0). Router2 and Router3 are in this area. They provide a
redundant connection between area 1.1.1.1 and area 2.2.2.2.

To configure Router3 interfaces - web-based manager

1. Go to System > Dashboard > Status.
2. Next to hostname, select Change.
3. Enter a hostname of Router3 and select OK.
4. Go to Network > Interfaces, edit port1 (internal), set the following information, and select OK.

Alias internal
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IP/Network Mask 10.11.103.3/255.255.255.0

Administrative Access HTTPS SSH PING

Description Internal RnD network

Administrative Status Up

5. Edit port2 (external1), set the following information and select OK.

Alias external1

IP/Network Mask 10.11.110.3/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router2 first connection

Administrative Status Up

6. Edit port3 (external2), set the following information and select OK.

Alias external2

IP/Network Mask 10.11.111.3/255.255.255.0

Administrative Access HTTPS SSH PING

Description Router2 second connection

Administrative Status Up

Configuring Router4

Router4 is part of the Network Administration regular area (2.2.2.2). This area provides Internet access for both
area 1.1.1.1 and the backbone area.

This section configures interfaces and hostname.

To configure Router4 interfaces - web-based manager

1. Go to System > Dashboard > Status.
2. Next to hostname, select Change.
3. Enter a hostname of Router4 and select OK.
4. Go to Network > Interfaces.
5. Edit port1 (internal).
6. Set the following information and select OK.
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Alias internal

IP/Network Mask 10.11.101.4/255.255.255.0

Administrative Access HTTPS SSH PING

Description Accounting network

Administrative Status Up

7. Edit port2 (external2).
8. Set the following information and select OK.

Alias external2

IP/Network Mask 10.11.110.4/255.255.255.0

Administrative Access HTTPS SSH PING

Description Backbone and Accounting network

Administrative Status Up

9. Edit port3 (ISP).
10. Set the following information and select OK.

Alias ISP

IP/Network Mask 172.20.120.4/255.255.255.0

Administrative Access HTTPS SSH PING

Description ISP and Internet

Administrative Status Up

Configuring OSPF on the FortiGate units

Three of the routers are designated routers (DR) and one is a backup DR (BDR). This is achieved through the
lowest router ID numbers, or OSPF priority settings.

Also, each area needs to be configured as each respective type of area: stub, backbone, or regular. This affects
how routes are advertised into the area.

To configure OSPF on Router1 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. Enter 10.11.101.1 for the Router ID and select Apply.
3. In Areas, select Create New, set the following information, and select OK.
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Area 1.1.1.1

Type Stub

Authentication None

4. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.101.0/255.255.255.0

Area 1.1.1.1

5. In Interfaces, select Create New, set the following information, and select OK.

Name Accounting

Interface port1 (internal)

IP 10.11.101.1

Authentication None

6. In Interfaces, select Create New, set the following information, and select OK.

Name Backbone1

Interface port2 (external1)

IP 10.11.110.1

Authentication None

To configure OSPF on Router2 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. Enter 10.11.102.2 for the Router ID and select Apply.
3. In Areas, select Create New, set the following information, and select OK.

Area 0.0.0.0

Type Regular

Authentication None

4. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.102.2/255.255.255.0

Area 0.0.0.0
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5. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.110.2/255.255.255.0

Area 0.0.0.0

6. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.111.2/255.255.255.0

Area 0.0.0.0

7. In Interfaces, select Create New, set the following information, and select OK.

Name RnD network

Interface port1 (internal)

IP 10.11.102.2

Authentication None

8. In Interfaces, select Create New, set the following information, and select OK.

Name Backbone1

Interface port2 (external1)

IP 10.11.110.2

Authentication None

9. In Interfaces, select Create New, set the following information, and select OK.

Name Backbone2

Interface port3 (external2)

IP 10.11.111.2

Authentication None

To configure OSPF on Router3 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. Enter 10.11.103.3 for the Router ID and select Apply.
3. In Areas, select Create New, set the following information, and select OK.

Area 0.0.0.0
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Type Regular

Authentication None

4. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.102.3/255.255.255.0

Area 0.0.0.0

5. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.110.3/255.255.255.0

Area 0.0.0.0

6. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.111.3/255.255.255.0

Area 0.0.0.0

7. In Interfaces, select Create New, set the following information, and select OK.

Name RnD network

Interface port1 (internal)

IP 10.11.103.3

Authentication None

8. In Interfaces, select Create New, set the following information, and select OK.

Name Backbone1

Interface port2 (external1)

IP 10.11.110.3

Authentication None

9. In Interfaces, select Create New, set the following information, and select OK.

Name Backbone2

Interface port3 (external2)
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IP 10.11.111.3

Authentication None

To configure OSPF on Router4 - web-based manager

1. Go to Router > Dynamic > OSPF.
2. Enter 10.11.104.4 for the Router ID and then select Apply.
3. In Areas, select Create New.
4. Set the following information and select OK.

Area 2.2.2.2

Type Regular

Authentication None

5. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.104.0/255.255.255.0

Area 0.0.0.0

6. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 10.11.111.0/255.255.255.0

Area 0.0.0.0

7. In Networks, select Create New, set the following information, and select OK.

IP/Netmask 172.20.120.0/255.255.255.0

Area 0.0.0.0

8. In Interfaces, select Create New, set the following information, and select OK.

Name Network Admin network

Interface port1 (internal)

IP 10.11.104.4

Authentication None

9. In Interfaces, select Create New, set the following information, and select OK.

Name Backbone2
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Interface port2 (external2)

IP 10.11.111.4

Authentication None

10. In Interfaces, select Create New, set the following information, and select OK.

Name ISP

Interface port3 (ISP)

IP 172.20.120.4

Authentication None

Configuring other networking devices

All network devices on this network are running OSPF routing. The user networks (Accounting, R&D, and Network
Administration) are part of one of the three areas.

The ISP needs to be notified of your network configuration for area 2.2.2.2. Your ISP will not advertise your areas
externally as they are intended as internal areas. External areas have assigned unique numbers. The area
numbers used in this example are similar to the 10.0.0.0 and 192.168.0.0 subnets used in internal networking.

Testing network configuration

There are two main areas to test in this network configuration: network connectivity and OSPF routing.

To test network connectivity, see if computers on the Accounting or R&D networks can access the Internet. If you
need troubleshooting network connectivity, see the FortiOS Handbook Troubleshooting chapter.

To test OSPF routing, check the routing tables on the FortiGate units to ensure the expected OSPF routes are
present. If you need help troubleshooting OSPF routing, see Advanced inter-area OSPF example on page 2583.

Controlling redundant links by cost
In this scenario, two FortiGate units have redundant links: one link between their WAN1 interfaces and another
between their WAN2 interfaces.
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FortiGate 1 should learn the route to network 192.168.182.0 and FortiGate 2 should learn the route to network
10.160.0.0. Under normal conditions, they should learn these routes through the WAN1 link. The WAN2 link
should be used only as a backup.

With the default settings, each FortiGate unit learns these routes from both WAN1 and WAN2.

FortiGate 1:

FGT1 # get router info ospf neighbor
OSPF process 0:
Neighbor ID Pri State Dead Time Address Interface
10.2.2.2 1 Full/Backup 00:00:33 10.182.0.187 wan1
10.2.2.2 1 Full/Backup 00:00:31 10.183.0.187 wan2
FGT1 # get router info routing-table ospf
O*E2 0.0.0.0/0 [110/10] via 10.183.0.187, wan2, 00:00:01
[110/10] via 10.182.0.187, wan1, 00:00:01
O 192.168.182.0/23 [110/20] via 10.183.0.187, wan2, 00:02:04
[110/20] via 10.182.0.187, wan1, 00:02:04

FortiGate 2:

FGT2 # get router info ospf neighbor
OSPF process 0:
Neighbor ID Pri State Dead Time Address Interface
10.1.1.1 1 Full/DR 00:00:38 10.182.0.57 wan1
10.1.1.1 1 Full/DR 00:00:38 10.183.0.57 wan2
FGT2 # get router info routing-table ospf
O 10.160.0.0/23 [110/20] via 10.183.0.57, wan2, 00:00:39
[110/20] via 10.182.0.57, wan1, 00:00:39
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Adjusting the route costs

On both FortiGate units, the cost of the route through WAN2 is adjusted higher so that this route will only be used
if the route through WAN1 is unavailable. The default cost is 10. The WAN2 route will be changed to a cost of
200.

On both FortiGate units:

config router ospf
config ospf-interface

edit "WAN2_higher_cost"
set cost 200
set interface "wan2"

end

Now, both FortiGate units use only the WAN1 route:

FortiGate 1:

FGT1 # get router info routing-table ospf
O*E2 0.0.0.0/0 [110/10] via 10.182.0.187, wan1, 00:00:40
O 192.168.182.0/23 [110/20] via 10.182.0.187, wan1, 00:00:40

FortiGate 2:

FGT2 # get router info routing-table ospf
O 10.160.0.0/23 [110/20] via 10.182.0.57, wan1, 00:09:37

LSDB check on FortiGate 1:

FGT1 # get router info ospf database router lsa
Router Link States (Area 0.0.0.0)
LS age: 81
Options: 0x2 (*|-|-|-|-|-|E|-)
Flags: 0x0
LS Type: router-LSA
Link State ID: 10.1.1.1
Advertising Router: 10.1.1.1
LS Seq Number: 8000000b
Checksum: 0xe637
Length: 60
Number of Links: 3

Link connected to: Stub Network
(Link ID) Network/subnet number: 10.160.0.0
(Link Data) Network Mask: 255.255.254.0
Number of TOS metrics: 0
TOS 0 Metric: 10
Link connected to: a Transit Network
(Link ID) Designated Router address: 10.183.0.187
(Link Data) Router Interface address: 10.183.0.57
Number of TOS metrics: 0
TOS 0 Metric: 200

Link connected to: a Transit Network
(Link ID) Designated Router address: 10.182.0.57
(Link Data) Router Interface address: 10.182.0.57
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Number of TOS metrics: 0
TOS 0 Metric: 10

LS age: 83
Options: 0x2 (*|-|-|-|-|-|E|-)
Flags: 0x2 : ASBR
LS Type: router-LSA
Link State ID: 10.2.2.2
Advertising Router: 10.2.2.2
LS Seq Number: 8000000e
Checksum: 0xfc9b
Length: 60

Number of Links: 3

Link connected to: Stub Network
(Link ID) Network/subnet number: 192.168.182.0
(Link Data) Network Mask: 255.255.254.0
Number of TOS metrics: 0
TOS 0 Metric: 10

Link connected to: a Transit Network
(Link ID) Designated Router address: 10.183.0.187
(Link Data) Router Interface address: 10.183.0.187
Number of TOS metrics: 0
TOS 0 Metric: 200

Link connected to: a Transit Network
(Link ID) Designated Router address: 10.182.0.57
(Link Data) Router Interface address: 10.182.0.187
Number of TOS metrics: 0
TOS 0 Metric: 10

Verifying route redundancy

Bring down WAN1 and then check the routes on the two FortiGate units.

FortiGate 1:

FGT1 # get router info routing-table ospf
FGT1 # get router info routing-table ospf
O*E2 0.0.0.0/0 [110/10] via 10.183.0.187, wan2, 00:00:06
O 192.168.182.0/23 [110/210] via 10.183.0.187, wan2, 00:00:06

FortiGate 2:

FGT2 # get router info routing-table ospf
O 10.160.0.0/23 [110/210] via 10.183.0.57, wan2, 00:00:14

The WAN2 interface is now in use on both units.
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This section describes Border Gateway Protocol (BGP).

BGP background and concepts
BGP contains two distinct subsets: internal BGP (iBGP) and external BGP (eBGP). iBGP is intended for use within
your own networks. eBGP is used to connect many different networks together and is the main routing protocol
for the Internet backbone. FortiGate units support iBGP, and eBGP only for communities.

Background

BGPwas first used in 1989. The current version, BGP-4, was released in 1995 and is defined in RFC 1771. That
RFC has since been replaced by RFC 4271. The main benefits of BGP-4 are classless inter-domain routing and
aggregate routes. BGP is the only routing protocol to use TCP for a transport protocol. Other routing protocols
use UDP.

BGPmakes routing decisions based on path, network policies, and rulesets instead of the hop-count metric as
RIP does, or cost-factor metrics as OSPF does.

BGP-4+ supports IPv6. It was introduced in RFC 2858 and RFC 2545.

BGP is the routing protocol used on the Internet. It was designed to replace the old Exterior Gateway Protocol
(EGP) which had been around since 1982, and was very limited. BGP enabled more networks to take part in the
Internet backbone to effectively decentralize it and make the Internet more robust, and less dependent on a
single ISP or backbone network.

Parts and terminology of BGP

In a BGP network, there are some terms that need to be explained before going ahead. Some parts of BGP are
not explained here because they are common to other dynamic routing protocols. When determining your
network topology, note that the number of available or supported routes is not set by the configuration but
depends on your FortiGate’s available memory. For more information about the parts of BGP that are not listed
here, see Dynamic routing overview on page 2503.

BGP and IPv6

FortiGate units support IPv6 over BGP using the same config router bgp command as IPv4 but different
subcommands.

The main CLI keywords have IPv6 equivalents that are identified by the “6” on the end of the keyword, such as
config network6 or set allowas-in6. For more information about IPv6 BGP keywords, see the
FortiGate CLI Reference.

IPv6 BGP commands include:

config router bgp
set activate6 {enable | disable}
set allowas-in6 <max_num_AS_integer>
set allowas-in-enable6 {enable | disable}
set as-override6 {enable | disable}
set attribute-unchanged6 [as-path] [med] [next-hop]
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set capability-default-originate6 {enable | disable}
set capability-graceful-restart6 {enable | disable}
set capability-orf6 {both | none | receive | send}
set default-originate-route-map6 <routemap_str>
set distribute-list-in6 <access-list-name_str>
set distribute-list-out6 <access-list-name_str>
set filter-list-in6 <aspath-list-name_str>
set filter-list-out6 <aspath-list-name_str>
set maximum-prefix6 <prefix_integer>
set maximum-prefix-threshold6 <percentage_integer>
set maximum-prefix-warning-only6 {enable | disable}
set next-hop-self6 {enable | disable}
set prefix-list-in6 <prefix-list-name_str>
set prefix-list-out6 <prefix-list-name_str>
set remove-private-as6 {enable | disable}
set route-map-in6 <routemap-name_str>
set route-map-out6 <routemap-name_str>
set route-reflector-client6 {enable | disable}
set route-server-client6 {enable | disable}
set send-community6 {both | disable | extended | standard}
set soft-reconfiguration6 {enable | disable}
set unsuppress-map6 <route-map-name_str>
config network6
config redistribute6

end

Role of routers in BGP networks

Dynamic routing has a number of different roles that routers can fill, such as those covered in Dynamic routing
overview on page 2503. BGP has a number of custom roles that routers can fill. These include:

l Speaker routers
l Peer routers or neighbors
l Route reflectors

Speaker routers

Any router configured for BGP is considered a BGP speaker. This means that a speaker router advertises BGP
routes to its peers.

Any routers on the network that are not speaker routers are not treated as BGP routers.

Peer routers or neighbors

In a BGP network, all neighboring BGP routers or peer routers are routers that are connected to your FortiGate
unit. Your FortiGate unit learns about all other routers through these peers.

You need to manually configure BGP peers on your FortiGate unit as neighbors. Otherwise, these routers will not
be seen as peers, but simply as other routers on the network that do not support BGP. Optionally, you can use
MD5 authentication to password-protect BGP sessions with those neighbors (see RFC 2385).

You can configure up to 1000 BGP neighbors on your FortiGate unit. You can clear all or some BGP neighbor
connections (sessions), using the execute router clear bgp command.

For example, if you have 10 routes in the BGP routing table and you want to clear the specific route to IP address
10.10.10.1, enter the command:
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execute router clear bgp ip 10.10.10.1

To remove all routes for AS number 650001, enter the command:

execute router clear bgp as 650001

To remove route flap dampening information for the 10.10.0.0/16 subnet, enter the command:

execute router clear bgp dampening 10.10.0.0/16

In the following diagram, Router A is directly connected to five other routers in a network that contains 12 routers.
These routers (the ones in the blue circle) are Router A’s peers or neighbors.

Router A and its five peer routers

As a minimum, when configuring BGP neighbors, you must enter their IP address and the AS number (remote-
as). This is all of the information the web-based manager interface allows you to enter for a neighbor.

The BGP commands related to neighbors are quite extensive and include:

config router bgp
config neighbor

edit <neighbor_address_ipv4>
set activate {enable | disable}
set advertisement-interval <seconds_integer>
set allowas-in <max_num_AS_integer>
set allowas-in-enable {enable | disable}
set as-override {enable | disable}
set attribute-unchanged [as-path] [med] [next-hop]
set bfd {enable | disable}
set capability-default-originate {enable | disable}
set capability-dynamic {enable | disable}
set capability-graceful-restart {enable | disable}
set capability-orf {both | none | receive | send}
set capability-route-refresh {enable | disable}
set connect-timer <seconds_integer>
set description <text_str>
set distribute-list-in <access-list-name_str>
set distribute-list-out <access-list-name_str>
set dont-capability-negotiate {enable | disable}
set ebgp-enforce-multihop {enable | disable}
set ebgp-multihop {enable | disable}
set ebgp-multihop-ttl <seconds_integer>
set filter-list-in <aspath-list-name_str>
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set filter-list-out <aspath-list-name_str>
set holdtime-timer <seconds_integer>
set interface <interface-name_str>
set keep-alive-timer <seconds_integer>
set maximum-prefix <prefix_integer>
set maximum-prefix-threshold <percentage_integer>
set maximum-prefix-warning-only {enable | disable}
set next-hop-self {enable | disable}
set passive {enable | disable}
set password <string>
set prefix-list-in <prefix-list-name_str>
set prefix-list-out <prefix-list-name_str>
set remote-as <id_integer>
set remove-private-as {enable | disable}
set retain-stale-time <seconds_integer>
set route-map-in <routemap-name_str>
set route-map-out <routemap-name_str>
set route-reflector-client {enable | disable}
set route-server-client {enable | disable}
set send-community {both | disable | extended | standard}
set shutdown {enable | disable}
set soft-reconfiguration {enable | disable}
set strict-capability-match {enable | disable}
set unsuppress-map <route-map-name_str>
set update-source <interface-name_str>
set weight <weight_integer>

end
end

end

Route reflectors

Route reflectors (RR) in BGP concentrate route updates so other routers only need to talk to the RRs to get all of
the updates. This results in smaller routing tables, fewer connections between routers, faster responses to
network topology changes, and less administration bandwidth. BGPRRs are defined in RFC 1966.

In a BGPRR configuration, the AS is divided into different clusters that each include client and reflector routers.
The client routers supply the reflector routers with the client’s route updates. The reflectors pass this information
along to other RRs and border routers. Only the reflectors need to be configured, not the clients, because the
clients will find the closest reflector and communicate with it automatically. The reflectors communicate with
each other as peers. FortiGate units can be configured as either reflectors or clients.

Since RRs are processing more than the client routers, the reflectors should have more resources to handle the
extra workload.

Smaller networks running BGP typically do not require RRs. However, RRs are a useful feature for large
companies, where their ASmay include 100 routers or more. For example, a full mesh 20 router configuration
within an AS, there would have to be 190 unique BGP sessions just for routing updates within the AS. The
number of sessions jumps to 435 sessions for just 30 routers, or 4950 sessions for 100 routers. Based on these
numbers, updating this many sessions will quickly consume the limited bandwidth and processing resources of
the routers involved.

The following diagram illustrates how RRs can improve the situation when only six routers are involved. The AS
without RRs requires 15 sessions between the routers. In the ASwith RRs, the two RRs receive route updates
from the reflector clients (unlabeled routers in the diagram) in their cluster, as well as other RRs, and pass them
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on to the border router. The RR configuration requires only six sessions. This example shows a reduction of 60%
for the number of required sessions.

Required sessions within an AS with and without RRs

The BGP commands related to RRs include:

config router bgp
config neighbor

set route-reflector-client {enable | disable}
set route-server-client {enable | disable}

end
end

Confederations

Confederations were introduced to reduce the number of BGP advertisements on a segment of the network and
reduce the size of the routing tables. Confederations essentially break up an AS into smaller units.
Confederations are defined in RFC 3065 and RFC 1965.

Within a confederation, all routers communicate with each other in a full mesh arrangement. Communications
between confederations is more like inter-AS communications because many of the attributes are changed as
they would be for BGP communications leaving the AS, or eBGP.

Confederations are useful when merging ASs. Each AS being merged can easily become a confederation, which
requires few changes. Any additional permanent changes can then be implemented over time, as required. The
diagram below shows the group of ASs before merging and the corresponding confederations afterward, as part
of the single AS with the addition of a new border router. It should be noted that after merging, if the border router
becomes a route reflector, then each confederation only needs to communicate with one other router instead of
five others.
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AS merging using confederations

Confederations and RRs perform similar functions: they both sub-divide large ASs for more efficient operation.
They differ in that route reflector clusters can include routers that are not members of a cluster, whereas routers
in a confederation must belong to that confederation. Also, confederations place their confederation numbers in
the AS_PATH attribute, making it easier to trace.

It is important to note that while confederations essentially create sub-ASs, all the confederations within an AS
appear as a single AS to external ASs.

Confederation related BGP commands include:

config router bgp
set confederation-identifier <peerid_integer>

end

BGP conditional advertisements

Normally, routes are propagated regardless of the existence of a different path. The BGP conditional
advertisement feature allows a route not to be advertised, based on the existence or non-existence of other
routes. With this feature, a child table under bgp.neighbor is introduced. Any route matched by one of the route-
maps specified in the table will be advertised to the peer, based on the corresponding route-map condition.

You can enable and disable conditional advertisements using the CLI.

To configure BGP conditional advertisements - CLI:

config router bgp
set as 3

config neighbor
edit "10.10.10.10"

set remote-as 3
config conditional-advertise

edit "route-map-to-match-sending"
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set condition-routemap "route-map-to-match-condition"
set condition-type [exist | non-exist]

next
end

next
end

BGP neighbor groups

The BGP neighbor group feature allows a large number of neighbors to be configured automatically based on a
range of neighbors' source addresses.

To configure BGP neighbor groups - CLI:

Start by adding a BGP neighbor group:

config router bgp
config neighbor-group

edit <neighbor-group-name>
set remote-as 100

...

(All options for BGP neighbor group are supported except password.)

end

Then add a BGP neighbor range:

config router bgp
config neighbor-range

edit 1
set prefix 192.168.1.0/24
set max-neighbor-num 100
set neighbor-group <neighbor-group-name>

next
end

Network Layer Reachability Information

Network Layer Reachability Information (NLRI) is unique to BGP-4. It is sent as part of the update messages sent
between BGP routers and contains information necessary to supernet, or aggregate route, information. The NLRI
includes the length and prefix that, when combined, are the address of the aggregated routes referred to.

There is only one NLRI entry per BGP update message.

BGP attributes

Each route in a BGP network has a set of attributes associated with it. These attributes define the route and are
modified, as required, along the route.

BGP can work well with mostly default settings, but if you are going to change settings you need to understand
the roles of each attribute and how they affect those settings.

The BGP attributes include:
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Attribute Description

AS_PATH A list of ASs a route has passed through. For more information, see AS_PATH on
page 2605.

MULTI_EXIT_DESC
(MED)

Which router to use to exit an AS with more than one external connection. For more
information, see MULTI_EXIT_DESC on page 2606.

COMMUNITY Used to apply attributes to a group of routes. For more information, see
COMMUNITY on page 2606.

NEXT_HOP Where the IP packets should be forwarded to, like a gateway in static routing. For
more information, see NEXT_HOP on page 2607.

ATOMIC_
AGGREGATE

Used when routes have been summarized to tell downstream routers not to de-
aggregate the route. For more information, see ATOMIC_AGGREGATE on page
2607.

ORIGIN Used to determine if the route is from the local AS or not. For more information, see
ORIGIN on page 2607.

LOCAL_PREF Used only within an AS to select the best route to a location (like MED).

Inbound policies on FortiGate units can change the NEXT-HOP,LOCAL-PREF, MED
and AS-PATH attributes of an internal BGP (iBGP) route for its local route selection
purposes. However, outbound policies on the unit cannot affect these attributes.

AS_PATH

AS_PATH is the BGP attribute that keeps track of each AS that a route advertisement has passed through. AS_
PATH is used by confederations and by exterior BGP (EBGP) to help prevent routing loops. A router knows there
is a loop if it receives an AS_PATH with that router's AS in it. The diagram below shows the route between Router
A and Router B. The AS_PATH from A to B would read 701,702,703 for each AS that the route passes through.

As of the beginning of 2010, the industry upgraded from 2-byte to 4-byte AS_PATHs. This upgrade was due to the
imminent exhaustion of 2-byte AS_PATH numbers. FortiOS supports 4-byte AS_PATHs in its BGP
implementation.
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AS_PATH of 701,702, 703 between routers A and B

The BGP commands related to AS_PATH include:

config router bgp
set bestpath-as-path-ignore {enable | disable}

end

MULTI_EXIT_DESC

BGPAS systems can have one or more routers that connect them to other ASs. For ASs with more than one
connecting router, the Multi-Exit Discriminator (MED) lists which router is best to use when leaving the AS. The
MED is based on attributes, such as delay. It is a recommendation only, as some networks may have different
priorities.

BGP updates advertise the best path to a destination network. When the FortiGate unit receives a BGP update,
the FortiGate unit examines the MED attribute of potential routes to determine the best path to a destination
network before recording the path in the local FortiGate unit routing table.

FortiGate units have the option to treat any routes without an MED attribute as the worst possible routing choice.
This can be useful because a lack of MED information is a lack of routing information, which can be suspicious as
a possible hacking attempt or an attack on the network. At best, it signifies an unreliable route to select.

The BGP commands related to MED include:

config router bgp
set always-compare-med {enable | disable}
set bestpath-med-confed {enable | disable}
set bestpath-med-missing-as-worst {enable | disable}
set deterministic-med {enable | disable}
config neighbor

set attribute-unchanged [as-path] [med] [next-hop]
end

end

COMMUNITY

A community is a group of routes that have the same routing policies applied to them. This saves time and
resources. A community is defined by the COMMUNITY attribute of a BGP route.
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The FortiGate unit can set the COMMUNITY attribute of a route to assign the route to predefined paths (see RFC
1997). The FortiGate unit can examine the COMMUNITY attribute of learned routes to perform local filtering
and/or redistribution.

The BGP commands related to COMMUNITY include:

config router bgp
set send-community {both | disable | extended | standard}

end

NEXT_HOP

The NEXT_HOP attribute says what IP address the packets should be forwarded to next. Each time the route is
advertised, this value is updated. The NEXT_HOP attribute is much like a gateway in static routing.

FortiGate units allow you to to change the advertising of the FortiGate unit’s IP address (instead of the neighbor’s
IP address) in the NEXT_HOP information that is sent to IBGP peers. This is changed with the config
neighbor, set next-hop-self command.

The BGP commands related to NEXT_HOP include:

config router bgp
config neighbor

set attribute-unchanged [as-path] [med] [next-hop]
set next-hop-self {enable | disable}

end
end

ATOMIC_AGGREGATE

The ATOMIC_AGGREGATE attribute is used when routes have been summarized. It indicates which AS and
which router summarize the routes. It also tells downstream routers not to de-aggregate the route. Summarized
routes are routes with similar information that have been combined, or aggregated, into one route that is easier to
send in updates for. When it reaches its destination, the summarized routes are split back up into the individual
routes.

Your FortiGate unit does not specifically set this attribute in the BGP router command, but it is used in the route
map command.

The commands related to ATOMIC_AGGREGATE include:

config router route-map
edit <route_map_name>

config rule
edit <route_map_rule_id>

set set-aggregator-as <id_integer>
set set-aggregator-ip <address_ipv4>
set set-atomic-aggregate {enable | disable}

end
end

end

ORIGIN

The ORIGIN attribute records where the route came from. The options can be IBGP, EBGP, or incomplete. This
information is important because internal routes (IBGP) are, by default, higher priority than external routes
(EBGP). However, incomplete ORIGINs are the lowest priority of the three.
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The commands related to ORIGIN include:

config router route-map
edit <route_map_name>

set comments <string>
config rule
edit <route_map_rule_id>

set match-origin {egp | igp | incomplete | none}
end

end
end

How BGP works

BGP is a link-state routing protocol and keeps link-state information about the status of each network link it has
connected. A BGP router receives information from its peer routers that have been defined as neighbors. BGP
routers listen for updates from these configured neighboring routers on TCP port 179.

A BGP router is a finite state machine with six various states for each connection. As two BGP routers discover
each other and establish a connection, they go from the idle state and through the various states until they reach
the established state. An error can cause the connection to be dropped and the state of the router to be reset to
either active or idle. These errors can be caused by: TCP port 179 not being open, a random TCP port above port
1023 not being open, the peer address being incorrect, or the AS number being incorrect.

When BGP routers start a connection, they negotiate which (if any) optional features will be used, such as
multiprotocol extensions, that can include IPv6 and VPNs.

IBGP versus EBGP

When you read about BGP, you often see EBGP or IBGPmentioned. These are both BGP routing, but BGP used
in different roles. Exterior BGP (EBGP) involves packets crossing multiple autonomous systems (ASs) and interior
BGP (IBGP) involves packets that stay within a single AS. For example, the AS_PATH attribute is only useful for
EBGPwhere routes pass through multiple ASs.

These two modes are important because some features of BGP are used only for one of EBGP or IBGP. For
example, confederations are used in EBGP and RRs are used only in IBGP. Also, routes learned from IBGP have
priority over routes learned from EBGP.

FortiGate units have some commands that are specific to EBGP, including:

l automatically resetting the session information to external peers if the connection goes down:set fast-
external-failover {enable | disable}

l setting an administrative distance for all routes learned from external peers (you must also configure local and
internal distances if this is set):set distance-external <distance_integer>

l enforcing EBGPmultihops and their TTL (number of hops): set ebgp-enforce-multihop {enable |
disable} and set ebgp-multihop-ttl <seconds_integer>

BGP path determination: which route to use

Firstly, recall that the number of available or supported routes is not set by the configuration but depends on your
FortiGate’s available memory. All learned routes and their attributes come into the BGP router in raw form.
Before routes are installed in the routing table or are advertised to other routers, three levels of decisions must be
made.
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The three phases of BGP best path determination do not change. However, some manufacturers have added
more information to the process, such as Cisco’s WEIGHT attribute, to allow an administrator to force one route’s
selection over another.

There is one Adj-RIB-IN and Adj-RIB-OUT for each configured neighbor. They are updated when the FortiGate
unit receives BGP updates or when the FortiGate unit sends out BGP updates.

The three phases of a BGP routing decision

Decision phase 1

At this phase, the decision is to calculate how preferred each route and its NRLI are the Adjacent Routing
Information Base Incoming (Adj-RIBs-In) compared to the other routes. For internal routes (IBGP), policy
information or LOCAL_PREF is used. For external peer learned routes, it is based strictly on policy. These rules
set up a list of which routes are most preferred going into Phase 2.
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Decision phase 2

Phase 2 involves installing the best route to each destination into the local Routing Information Base (Loc-RIB).
Effectively, the Loc-RIB is the master routing table. Each route from Phase 1 has their NEXT_HOP checked to
ensure the destination is reachable. If it is reachable, the AS_PATH is checked for loops. After that, routes are
installed based on the following decision process:

l If there is only one route to a location, it is installed.
l If there are multiple routes to the same location, use the most preferred route from Level 1.
l If there is a tie, break the tie based on the following, in descending order of importance: shortest AS_PATH,

smallest ORIGIN number, smallest MED, EBGP over IBGP, smallest metric or cost for reaching the NEXT_HOP,
BGP identifier, and lowest IP address.

Note that the new routes that are installed into the Loc-RIB are in addition to any existing routes in the table.
Once Phase 2 is completed, the Loc-RIB will consist of the best of both the new and older routes.

Decision phase 3

Phase 3 is route distribution or dissemination. This is the process of deciding which routes the router will
advertise. If there is any route aggregation or summarizing, it happens here. Also, any route filtering from route
maps happens here.

Once Phase 3 is complete, an update can be sent out to update the neighbor of new routes.

Aggregate routes and addresses

BGP-4 allows classless routing, which uses netmasks as well as IP addresses. This classless routing allows the
configuration of aggregate routes by stating the address bits the aggregated addresses have in common. For
more information, see Dynamic routing overview on page 2503.

The ATOMIC_AGGREGATE attribute informs routers that the route has been aggregated and should not be de-
aggregated. An associated AGGREGATOR attribute include the information about the router that did the
aggregating including its AS.

The BGP commands associated with aggregate routes and addresses are:

config router bgp
config aggregate-address

edit <aggr_addr_id>
set as-set {enable | disable}
set prefix <address_ipv4mask>
set summary-only {enable | disable}

end
config aggregate-address6

edit <aggr_addr_id>
set as-set {enable | disable}
set prefix6 <address_ipv6mask>
set summary-only {enable | disable}

end

Configuring BGP graceful restart process on timer

You can configure the BGP graceful restart process to stop only when the restart timer expires, using the
following CLI commands:

config router bgp
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set graceful-end-on-timer enable

Configuring option to bring down BGP neighbor when the link is down

You can configure an option to bring down BGP neighbors when the outgoing interface is down, using the
following CLI commands:

config router bgp
config neighbor

edit <ip_address>
set linkdown-failover enable

Configuring option to keep routes for a period after the BGP neighbor is down

You can configure an option to keep routes for a period after the BGP neighbor is down. If you enable this option
for a BGP neighbor, the route learned from the neighbor is kept for the configured graceful-stalepath-
time after the neighbor is down because of hold timer expiration or TCP connection failure.

To configure this option, use the following CLI commands:

config router bgp
config neighbor

edit <ip_address>
set stale-route enable

BGP local-AS support

FortiGate supports BGP local-AS. Local-AS allows you to configure a BGP speaker to have a real local-AS and a
secondary local-AS for a specific neighbor, so its local-AS number appears different to different neighbors.

You can configure a BGP speaker to have a real local-AS and a secondary local-AS for a specific neighbor, so the
local-AS number appears different to neighbor B and neighbor A.

Configuring BGP local-AS

To configure BGP local-AS for BGP peers, use the following CLI commands:

config router bgp
config neighbor

edit “neighbor” / edit <ip_address>
…
set local-as 300 (?) / set local-as <integer>
set local-as-no-prepend {enable | disable}
set local-as-replace-as {enable | disable}

end

CLI option Description

<ip_address> The IP/IPv6 address of neighbor

<local-as <integer>> The local-AS number

local-as-no-prepend { enable |
disable}

Set this to enable if you do not want to prepent local-AS to incoming
updates.
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CLI option Description

local-as-replace-as { enable |
disable}

Set this to enable to replace a real AS with local-AS in outgoing
updates.

Troubleshooting BGP
There are some features in BGP that are used to deal with problems that may arise. Typically, the problems with
a BGP network that has been configured involve routes going offline frequently. This is called route flap and
causes problems for the routers using that route.

Clearing routing table entries

To see if a new route is being properly added to the routing table, you can clear all or some BGP neighbor
connections (sessions) using the execute router clear bgp command.

For example, if you have 10 routes in the BGP routing table and you want to clear the specific route to IP address
10.10.10.1, enter the command:

execute router clear bgp ip 10.10.10.1

To remove all routes for AS number 650001, enter the command:

execute router clear bgp as 650001

Route flap

When routers or hardware along a route go offline and back online that is called a route flap. Flapping is the term
that is used if these outages continue, especially if they occur frequently.

Route flap is a problem in BGP because each time a peer or a route goes down, all the peer routers that are
connected to that out-of-service router advertise the change in their routing tables. This creates a lot of
administration traffic on the network and the same traffic re-occurs when that router comes back online. If the
problem is something like a faulty network cable that wobbles online and offline every 10 seconds, there could
easily be an overwhelming amount of routing updates sent out unnecessarily.

Another possible reason for route flap occurs with multiple FortiGate units in HAmode. When an HA cluster fails
over to the secondary unit, other routers on the network may see the HA cluster as being offline resulting in route
flap. While this does not occur often, or more than once at a time, it can still result in an interruption in traffic
which is unpleasant for network users. The easy solution for this problem is to increase the timers on the HA
cluster, such as TTL timers, so they do not expire during the failover process. Also, configuring graceful restart on
the HA cluster will help with a smooth failover.

The first method of dealing with route flap should be to check your hardware. If a cable is loose or bad, it can
easily be replaced and eliminate the problem. If an interface on the router is bad, either avoid using that interface
or swap in a functioning router. If the power source is bad on a router, either replace the power supply or use a
power conditioning backup power supply. These quick and easy fixes can save you from configuring more
complex BGP options. However, if the route flap is from another source, configuring BGP to deal with the outages
will ensure your network users uninterrupted service.

Some methods of dealing with route flap in BGP include:

l Holdtime timer
l Dampening
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l Graceful restart
l Bi-directional forwarding detection

Holdtime timer

The first line of defense to a flapping route is the holdtime timer. This timer reduces how frequently a route going
down will cause a routing update to be broadcast.

Once activated, the holdtime timer will not allow the FortiGate unit to accept any changes to that route for the
duration of the timer. If the route flaps five times during the timer period, only the first outage will be recognized
by the FortiGate unit. For the duration of the other outages, there will be no changes because the Fortigate unit is
essentially treating this router as down. If the route is still flapping after the timer expires, it will happen all over
again.

Even if the route is not flapping (for example, if it goes down, comes up, and stays back up) the timer still counts
down and the route is ignored for the duration of the timer. In this situation, the route will be seen as down longer
than it really is but there will be only the one set of route updates. This is not a problem in normal operation
because updates are not frequent.

Also, the potential for a route to be treated as down when it is really up can be viewed as a robustness feature.
Typically, you do not want most of your traffic being routed over an unreliable route. So if there is route flap going
on, it is best to avoid that route if you can. This is enforced by the holdtime timer.

How to configure the holdtime timer

There are three different route flapping situations that can occur: the route goes up and down frequently, the
route goes down and back up once over a long period of time, or the route goes down and stays down for a long
period of time. These can all be handled using the holdtime timer.

For example, your network has two routes that you want to set the holdtime timer for. One is your main route (to
10.12.101.4) that all of your Internet traffic goes through, and it cannot be down for long if it is down. The second
is a low speed connection to a custom network that is used infrequently (to 10.13.101.4). The holdtime timer for
the main route should be fairly short (for example, 60 seconds) instead of the default. The second route timer can
be left at the default, since it is rarely used. In your BGP configuration this looks like:

config router bgp
config neighbor
edit 10.12.101.4

set holdtime-timer 60
next
edit 10.13.101.4

set holdtime-timer 180
next
end

end

Dampening

Dampening is a method used to limit the amount of network problems due to flapping routes. With dampening,
the flapping still occurs but the peer routers pay less and less attention to that route as it flaps more often. One
flap does not start dampening, but the second flap starts a timer where the router will not use that route because
it is considered unstable. If the route flaps again before the timer expires, the timer continues to increase. There
is a period of time called the reachability half-life, after which a route flap will be suppressed for only half the time.
This half-life comes into effect when a route has been stable for a while but not long enough to clear all the
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dampening completely. For the flapping route to be included in the routing table again, the suppression time
must expire.

If the route flapping was temporary, you can clear the flapping or dampening from the FortiGate units cache by
using one of the execute router clear bgp commands:

execute router clear bgp dampening {<ip_address> | <ip/netmask>}
or
execute router clear bgp flap-statistics {<ip> | <ip/netmask>}

For example, to remove route flap dampening information for the 10.10.0.0/16 subnet, enter the command:

execute router clear bgp dampening 10.10.0.0/16

The BGP commands related to route dampening are:

config router bgp
set dampening {enable | disable}
set dampening-max-suppress-time <minutes_integer>
set dampening-reachability-half-life <minutes_integer>
set dampening-reuse <reuse_integer>
set dampening-route-map <routemap-name_str>
set dampening-suppress <limit_integer>
set dampening-unreachability-half-life <minutes_integer>

end

Graceful restart

BGP4 has the capability to gracefully restart.

In some situations, route flap is caused by routers that appear to be offline but the hardware portion of the router
(control plane) can continue to function normally. One example of this is when some software is restarting or
being upgraded but the hardware can still function normally.

Graceful restart is best used for these situations where routing will not be interrupted, but the router is
unresponsive to routing update advertisements. Graceful restart does not have to be supported by all routers in a
network, but the network will benefit when more routers support it.

FortiGate HA clusters can benefit from graceful restart. When a failover takes place,
the HA cluster will advertise that it is going offline, and will not appear as a route flap. It
will also enable the new HAmain unit to come online with an updated and usable
routing table. If there is a flap, the HA cluster routing table will be out-of-date.

For example, your FortiGate unit is one of four BGP routers that send updates to each other. Any of those routers
may support graceful starting. When a router plans to go offline, it sends a message to its neighbours stating how
long it expects to be offline. This way, its neighboring routers do not remove it from their routing tables. However,
if that router is not back online when expected, the routers will mark it offline. This prevents routing flap and its
associated problems.

Scheduled time offline

Graceful restart is a means for a router to advertise that it is going to have a scheduled shutdown for a very short
period of time. When neighboring routers receive this notice, they will not remove that router from their routing
table until after a set time elapses. During that time, if the router comes back online, everything continues to
function as normal. If that router remains offline longer than expected, then the neighboring routers will update
their routing tables as they assume that router will be offline for a long time.
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FortiGate units support both graceful restart of their own BGP routing software and neighboring BGP routers.

For example, if a neighbor of your FortiGate unit with an IP address of 172.20.120.120 supports graceful restart,
enter the command:

config router bgp
config neighbor
edit 172.20.120.120

set capability-graceful-restart enable
end

end

If you want to configure graceful restart on your FortiGate unit where you expect the Fortigate unit to be offline for
no more than 2 minutes, and after 3 minutes the BGP network should consider the FortiGate unit to be offline,
enter the command:

config router bgp
set graceful-restart enable
set graceful-restart-time 120
set graceful-stalepath-time 180

end

The BGP commands related to BGP graceful restart are:

config router bgp
set graceful-restart { disable| enable}
set graceful-restart-time <seconds_integer>
set graceful-stalepath-time <seconds_integer>
set graceful-update-delay <seconds_integer>
config neighbor

set capability-graceful-restart {enable | disable}
end

end

execute router restart

Before the restart, the router sends its peers a message to say it is restarting. The peers mark all the restarting
router's routes as stale, but they continue to use the routes. The peers assume the router will restart, check its
routes, and take care of them, if needed, after the restart is complete. The peers also know what services the
restarting router can maintain during its restart. After the router completes the restart, the router sends its peers a
message to say it is done restarting.

Bi-directional forwarding detection

Bi-directional Forwarding Detection (BFD) is a protocol used to quickly locate hardware failures in the network.
Routers running BFD communicate with each other, and if a timer runs out on a connection, that router is
declared down. BFD then communicates this information to the routing protocol and the routing information is
updated.

While BGP can detect route failures, BFD can be configured to detect these failures more quickly which allows for
faster responses and improved convergence. This can be balanced with the bandwidth BFD uses in its frequent
route checking.

Configurable granularity

BFD can run on the entire FortiGate unit, selected interfaces, or on BGP for all configured interfaces. The
hierarchy allows each lower level to override the upper level’s BFD setting. For example, if BFD was enabled for
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the FortiGate unit, it could be disabled only for a single interface or for BGP. For information about FortiGate-
wide BFD options, see config system settings in the FortiGate CLI Reference.

BFD can be configured only through the CLI.

The BGP commands related to BFD are:

config system {setting | interface}
set bfd {enable | disable | global}
set bfd-desired-mix-tx <milliseconds>
set bfd-detect-mult <multiplier>
set bfd-required-mix-rx <milliseconds>
set bfd-dont-enforce-src-port {enable | disable}

config router bgp
config neighbor

edit <neighbor_address_ipv4>
set bfd {enable | disable}

end
end

get router info bfd neighbor
execute router clear bfd session <src_ipv4> <dst_ipv4> <interface>

The config system commands allow you to configure whether BFD is enabled in a particular unit/vdom or
individual interface, and how often the interface requires the sending and receiving of BFD information.

The config router bgp commands allow you to set the addresses of the neighbor units that are also
running BFD. Both units must be configured with BFD in order to make use of it.

Dual-homed BGP example
This is an example of a small network that uses BGP routing connections to two ISPs. This is a common
configuration for companies that need redundant connections to the Internet for their business.

This configuration is for a small company connected to two ISPs. The company has one main office, the Head
Office, and uses static routing for internal routing on that network.

Both ISPs use BGP routing and connect to the Internet directly. They want the company to connect to the ISP
networks using BGP. They also use graceful restart to prevent updates that are not needed and use smaller timer
values to detect network failures faster.

As can be expected, the company wants to keep their BGP configuration relatively simple and easy to manage.
The current configuration has only 3 routers to worry about: the 2 ISP border routers and the FortiGate unit. This
means that the FortiGate unit will have only two neighbor routers to configure.

This configuration has the added benefit of being easy to expand if the company wants to add a remote office in
the future.

To keep the configuration simple, the company is allowing only HTTP, HTTPS, FTP, and DNS traffic out of the
local network. This will allow employees access to the Internet and their web mail.

Why dual home?

Dual homing means having two separate independent connections to the Internet. Servers in this configuration
have also been called bastion hosts and can include DNS servers which require multiple connections.

Benefits of dual homing can include:
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l Redundant Internet connection that essentially never fails
l Faster connections through one ISP or the other for some destinations, such as other clients of those ISPs
l Load balancing traffic to the company network
l Easier to enable more traffic through two connections than upgrading one connection to bigger bandwidth
l Easier to create protection policies for different traffic through a specific ISP

Some companies require reliable Internet access at all times as part of their business. Consider a doctor
operating remotely who has their Internet connection fail — the consequences can easily be life or death.

Dual homing is an extra expense for the second ISP connection and more work to configure and maintain the
more complex network topology.

Potential dual homing issues

BGP comes with load balancing issues and dual homing is in the same category. BGP does not inherently deal
well with load balancing or getting default routes through BGP. Ideally, one connection may be best for certain
destinations but it may not have that traffic routed to it, which makes the load balancing less than perfect. This
kind of fine tuning can be very time consuming and usually results in a best effort situation.

When dual homing is not configured properly, your network may become a link between your ISPs and result in
very high traffic between the ISPs that does not originate from your network. The problem with this situation is
that your traffic may not have the bandwidth it needs, and you will also be paying for a large volume of traffic that
is not yours. This problem can be solved by not broadcasting or redistributing BGP routes between the ISPs.

If you learn your default routes from the ISPs, in this example, you may run into an asymmetric routing problem
where your traffic loops out one ISP and back to you through the other ISP. If you think this may be happening,
you can turn on asymmetric routing on the FortiGate unit (config system settings, set asymmetric
enable) to verify if that is the problem. Turn this feature off once this is established, since it disables many
features on the FortiGate by disabling stateful inspection. Solutions to this problem can include using static
routes for default routes instead of learning them through BGP or configuring VDOMs on your FortiGate unit to
provide a slightly different path back that is not a true loop.

Network layout and assumptions

The network layout for the basic BGP example involves the company network being connected to both ISPs as
shown below. In this configuration, the FortiGate unit is the BGP border router between the Company AS, ISP1’s
AS, and ISP2’s AS.

The components of the layout include:

l The Company AS (AS number 1) is connected to ISP1 and ISP2 through the FortiGate unit.
l The Company has one internal network: the Head Office network at 10.11.101.0/24.
l The FortiGate unit internal interface is on the the company internal network with an IP address of 10.11.101.110.
l The FortiGate unit external1 interface is connected to ISP1’s network with an IP address of 172.20.111.5, which is

an address supplied by the ISP.
l The FortiGate unit external2 interface is connected to IPS2’s network with an IP address of 172.20.222.5, which is

an address supplied by the ISP.
l ISP1 AS has an AS number of 650001 and ISP2 has an AS number of 650002.
l Both ISPs are connected to the Internet.
l The ISP1 border router is a neighbor (peer) of the FortiGate unit. It has an address of 172.21.111.4.
l The ISP2 border router is a neighbor (peer) of the FortiGate unit. It has an address of 172.22.222.4.
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l Apart from graceful restart and shorter timers (holdtimer and keepalive), default settings are to be used whenever
possible.

Basic BGP network topology

Assumptions

The basic BGP configuration procedure follows these assumptions:

l ISP1 is the preferred route and ISP2 is the secondary route
l All basic configuration can be completed in both the GUI and CLI
l Only one AS is used for the company

For these reasons, this example configuration does not include:

l Bi-directional forwarding detection (BFD)
l Route maps
l Access lists
l Changing redistribution defaults (make link when example is set up)
l IPv6
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For more information about these features, see the corresponding section.

Configuring the FortiGate unit

In this topology, the FortiGate unit is the link between the company network and the ISP network. The FortiGate
unit is the only BGP router on the company network, but there is at least one other BGP router on the ISP
network. There may be more BGP routers, but we do not have that information.

As mentioned in the general configuration steps, the ISPmust be notified of the company’s BGP router
configuration when complete as it will need to add the FortiGate BGP router as a neighbor router on its domain.
This step is required for the FortiGate unit to receive BGP routing updates from the ISP network and outside
networks.

If the ISP has any special BGP features enabled, such as graceful restart or route dampening, that should be
determined ahead of time so those features can be enabled on the FortiGate unit.

To configure the FortiGate unit as a BGP router

1. Configure interfaces and default routes
2. Configure firewall services, addresses, and policies
3. Set the FortiGate BGP information
4. Add the internal network to the AS
5. Additional FortiGate BGP configuration

Configure interfaces and default routes

The FortiGate unit is connected to three networks: the company network on the internal interface, the ISP1
network on the external1 interface, and the ISP2 network on the external2 interface.

This example uses basic interface settings. Check with your ISP to determine if additional settings are required,
such as setting the maximum MTU size or if gateway detection is supported.

High end FortiGate units do not have interfaces labeled as Internal or External. Instead, for clarity, we are using
the alias feature to name interfaces for these roles.

Default routes to both external interfaces are configured here also. Both are needed in case one goes offline.
ISP1 is the primary connection and has a smaller administrative distance so it will be preferred over ISP2. Both
distances are set low so they will be preferred over any learned routes.

To configure the FortiGate interfaces - web-based manager

1. Go to Network > Interfaces.
2. Edit port 1 (internal) interface.
3. Set the following information and select OK.

Alias internal

IP/Network Mask 10.11.101.110/255.255.255.0

Administrative Access HTTPS SSH PING
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Comments Company internal network

Interface State Enabled

4. Edit port 2 (external1) interface.
5. Set the following information and select OK.

Alias external1

IP/Network Mask 172.21.111.5/255.255.255.0

Administrative Access HTTPS SSH PING

Comments ISP1 External BGP network

Interface State Enabled

6. Edit port 3 (external2) interface.
7. Set the following information and select OK.

Alias external2

IP/Network Mask 172.22.222.5/255.255.255.0

Administrative Access HTTPS SSH PING

Comments ISP2 External BGP network

Interface State Enabled

To configure the FortiGate interfaces - CLI

config system interface
edit port1

set alias internal
set ip 10.11.101.110 255.255.255.0
set allowaccess http https ssh
set description “Company internal network”
set status up

next
edit port2

set alias external1
set ip 172.21.111.5 255.255.255.0
set allowaccess https ssh
set description “ISP1 External BGP network”
set status up

next
edit port3

set alias external2
set ip 172.22.222.5 255.255.255.0
set allowaccess https ssh
set description “ISP2 External BGP network”
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set status up
next

end

To configure default routes for both ISPs - web-based manager

1. Go to Network > Static Routes.
2. Delete any existing routes with a IP/Mask of address of 0.0.0.0/0.0.0.0
3. Select Create New and set the following information.

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.21.111.5

Interface port2

Administrative Distance 10

4. Select OK.
5. Select Create New and set the following information.

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 172.22.222.5

Interface port3

Administrative Distance 15

6. Select OK.

To configure default routes for both ISPs - CLI

config router static
edit 1

set device "port2"
set distance 10
set gateway 172.21.111.5

next
edit 2

set device "port3"
set distance 15
set gateway 172.22.222.5

next
end

Configure firewall services, addresses, and policies

To create the security policies, you create the firewall services group that will include all the services that will be
allowed, define the addresses that will be used in the security policies, and configure the security policies
themselves.
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To keep the configuration simple, the company is allowing only HTTP traffic out of the local network. This will
allow employees access to the Internet and their web mail. DNS services will also be allowed through the firewall.

The security policies will allow HTTP traffic (port 80 and port 8080), HTTPS traffic (port 443), FTP traffic (port 21),
and DNS traffic (port 53 and port 953) in both directions. Also, BGP (port 179) may need access through the
firewall.

For added security, you may want to define a smaller range of addresses for the
internal network. For example, if only 20 addresses are used, only allow those
addresses in the range.

To keep things simple, a zone will be used to group the two ISP interfaces together. This will allow for the use of
one security policy to apply to both ISPs at the same time. Remember to block intra-zone traffic as this will help
prevent one ISP sending traffic to the other ISP through your FortiGate unit using your bandwidth. The zone
keeps configuration simple and if there is a need for separate policies for each ISP in the future, they can be
created and the zone can be deleted.

The addresses that will be used are the addresses of the FortiGate unit internal and external ports and the
internal network.

More policies or services can be added in the future as applications are added to the network.

When configuring security policies, always enable logging to help you track and debug
your traffic flow.

To create a firewall services group - web-based manager

1. Go to Policy & Objects > Services, select the dropdown arrow next to Create New and select Service Group.
2. ForGroup Name, enter “Basic_Services”.
3. From theMembers dropdown, choose the following six services: BGP, FTP, FTP_GET, FTP_PUT, DNS, HTTP,

and HTTPS.
4. Select OK.

To create a firewall services group - CLI

config firewall service group
edit "Basic_Services"

set member "BGP" "DNS" "FTP" "FTP_GET" "FTP_PUT" "HTTP" "HTTPS"
next

end

To create a zone for the ISP interfaces - web-based manager

1. Go to Network > Interfaces.
2. Select the caret to the right of Create New and then select Zone.
3. Enter the following information:

Name ISPs

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2622



BGP

Block intra-zone traffic enable

Interface Members port2 port3

4. Select OK.

To create a zone for the ISP interfaces - CLI

config system zone
edit "ISPs"

set interface "port2" "port3"
set intrazone block

next
end

To add the firewall addresses - web-based manager

1. Go to Policy & Objects > Addresses.
2. Select Create New and set the following information.

Category Address

Name Internal_network

Type Subnet / IP Range

Subnet / IP Range 10.11.101.0 255.255.255.0

Interface port1

3. Select OK.

To add the firewall addresses - CLI

config firewall address
edit "Internal_network"

set associated-interface "port1"
set subnet 10.11.101.0 255.255.255.0

next
end

To add the HTTP and DNS security policies - web-based manager

1. Go to Policy & Objects > IPv4 Policy, and select Create New.
2. Set the following information.

Incoming Interface port1(internal)

Outgoing Interface ISPs

2623 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



BGP

Source Internal_network

Destination All

Schedule Always

Service Basic_services

Action ACCEPT

Firewall / Network Options Enable NAT

Log Allowed Traffic Enable

Comments ISP1 basic services out policy

3. Select OK.
4. Select Create New and set the following information.

Incoming Interface ISPs

Outgoing Interface port1(internal)

Source All

Destination Internal_network

Schedule Always

Service Basic_services

Action ACCEPT

Firewall / Network Options Enable NAT

Log Allowed Traffic Enable

Comments ISP1 basic services in policy

To add the security policies - CLI

config firewall policy
edit 1

set srcintf "port1"
set srcaddr "Internal_network"
set dstintf "ISPs"
set dstaddr "all"
set schedule "always"
set service "Basic_services"
set action accept
set nat enable
set profile-status enable
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set logtraffic enable
set comments "ISP1 basic services out policy"

next
edit 2

set srcintf "ISPs"
set srcaddr "all"
set dstintf "port1"
set dstaddr "Internal_network"
set schedule "always"
set service "Basic_services"
set action accept
set nat enable
set profile-status enable
set logtraffic enable
set comments "ISP1 basic services in policy"

next
end

Set the FortiGate BGP information

When using the default information, there are only two fields to set to configure the FortiGate unit as a BGP
router.

For this configuration, the FortiGate unit will be in a stub area with one route out — the ISP BGP router. Until you
configure the ISP router as a neighbor, even that route out is not available. So, while after this part of the
configuration is complete, your FortiGate unit will be running BGP, it will not know about any other routers
running BGP until the next part of the configuration is complete.

To set the BGP router information - web-based mananger

1. Go to Network > BGP.
2. Set the following information and select OK.

Local AS 1

Router ID 10.11.101.110

To set the BGP router information - CLI

config router BGP
set as 1
set router-id 10.11.101.110

end

Add the internal network to the AS

The company is one ASwith the FortiGate unit configured as the BGP border router connecting that AS to the two
ISPs ASs. The internal network in the Company’s ASmust be defined. If there were other networks in the
company, such as regional offices, they would be added here as well.

To set the networks in the AS - web-based manager

1. Go to Network > BGP.
2. UnderNetworks, set the IP/Netmask to 10.11.101.0/255.255.255.0 and select Add.
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To set the networks in the AS - CLI

config router bgp
config network
edit 1

set prefix 10.11.101.0 255.255.255.0
next
end

end

Add BGP neighbor information

The configuration will not work unless you set Remote AS neighbors. This can be done in either the web-based
manager or the CLI.

To configure the BGP neighbors - web-based manager

1. Go to Network > BGP.
2. Add a Neighbors IP of 172.21.111.4 with the Remote AS set to 650001, then clickAdd/Edit.
3. Add anotherNeighbors IP of 172.22.222.4 with the Remote AS set to 650002, then clickAdd/Edit.

To configure the BGP neighbors - CLI

config router BGP
set as 1

config neighbor
edit “172.21.111.4”

set remote-as 650001
next
edit “172.22.222.4”

set remote-as 650002
next

end
end

Additional FortiGate BGP configuration

At this point, those are all the settings that can be done in both the web-based manger and the CLI. The
remaining configuration must be completed in the CLI.

These additional settings are mainly determined by your ISP requirements. They will determine your timers, such
as keepalive timers, if extended features like BFD and graceful restart are being used, and so on. For this
example, some common simple features are being used to promote faster detections of network failures, which
will result in better service for the company’s internal network users.

The ISPs do not require authentication between peer routers.

These commands will enable or modify the following features on the FortiGate unit and, where possible, on
neighboring routers as well:

l bestpath-med-missing-as-worst: treats a route without an MED as the worst possible available route due
to expected unreliability

l fast-external-failover: immediately reset the session information associated with BGP external peers if
the link used to reach them goes down
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l graceful-restart*: advertise reboots to neighbors so they do not see the router as offline, wait before
declaring them offline, and how long to wait when they reboot before advertising updates. These commands apply
to neighbors and are part of the BGP capabilities. This prevents unneeded routing updates.

l holdtime-timer: how long the router will wait for a keepalive message before declaring a router offline. A
shorter time will find an offline router faster.

l keepalive-timer: how often the router sends out keepalive messages to neighbor routers to maintain those
sessions.

l log-neighbor-changes: log changes to the status of neighbor routers. This can be useful for troubleshooting
from both internal and external networks.

l connect-timer: how long (in seconds) the FortiGate unit will try to reach this neighbor before declaring it offline.
l weight: used to prefer routes from one neighbor over the other. In this example, ISP1 is the primary connection so

it is weighted higher than ISP2

To configure additional BGP options - CLI

config router bgp
set bestpath-med-missing-as-worst enable
set fast-external-failover enable
set graceful-restart enable
set graceful-restart-time 120
set graceful-stalepath-time 180
set graceful-update-delay 180
set holdtime-timer 120
set keepalive-timer 45
set log-neighbor-changes enable
config neighbor

edit 172.21.111.4
set connect-timer 60
set description "ISP1"
set holdtime-timer 120
set keepalive-timer 45
set weight 250

next
edit 172.22.222.4

set connect-timer 60
set description "ISP2"
set holdtime-timer 120
set keepalive-timer 45
set weight 100

next
end

end

Configuring other networking devices

There are two other networking devices that need to be configured: the BGP routers for both ISPs.

The ISPs’ routers must add the FortiGate unit as a neighbor so route updates can be sent in both directions. Note
that ISP1 is not directly connected to ISP2, that we are aware of.

Inform both of your ISPs of your FortiGate unit’s BGP information. Once they have configured their router, you
can test your BGP connection to the Internet.

They will require your FortiGate unit’s:
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l IP address of the connected interface
l The router ID
l Your company’s AS number

Testing this configuration

With the dual-homed BGP configuration in place, you should be able to send and receive traffic, send and receive
routes, and not have any routing loops. Testing the networks will confirm that things are working as expected.

In general, for routing, you need to look at the routing table on different routers to see what routes are being
installed. You also need to sniff packets to see how traffic is being routed in real-time. These two sources of
information will normally tell you what you need to know.

Testing of this example’s network configuration should be completed in the following parts:

l Testing network connectivity
l Verifying the FortiGate unit’s routing tables
l Verifying traffic routing
l Verifying the dual-homed side of the configuration

Testing network connectivity

A common first step in testing a new network topology is to test to see if you can reach the Internet and other
locations as expected. If not, you may be prevented by cabling issues, software, or other issues.

The easiest way to test connections is to use ping, once you ensure that all the FortiGate unit’s interfaces and
ISP routers have ping support enabled. Also, ensure that the security policies allow ping through the firewall.

Connections to test, in this example, are the internal network to ISP1’s router or the Internet, and the same for
ISP2. If you can connect on the external side of the Fortinet unit, try to ping the internal network. These three
tests should prove your basic network connections are working.

Once you have finished testing the network connectivity, turn off ping support on the
external interfaces for additional security.

Verifying the FortiGate unit’s routing tables

The FortiGate routing table contains the routes that are stored for future use. If you are expecting certain routes
to be there and they are not, this is a good indicator that your configuration is not what you expected.

The get router info routing-table details CLI command will provide you with the routing
protocol, destination address, gateway address, interface, and weighting for every route, as well as if the address
is directly connected or not.

If you want to limit the display to BGP routes only, use the get router info routing-table bgp CLI
command. If there are no BGP routes in the routing table, nothing will be displayed. In the CLI command, you
can replace BGPwith static, or other routing protocols, to only display those routes.

If you want to see the contents of the routing information database (RIB), use the get router info
routing-table database CLI command. This will display the incoming routes that may or may not make it
into the routing table.
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Verifying traffic routing

Traffic may be reaching the internal network, but it may be using a different route than you think to get there.

Use a browser to try to access the Internet.

If needed, allow traceroute and other diag ports to be opened until things are working properly. Then remove
access for them again.

Look for slow hops on the traceroute, or pings to a location, as they may indicate network loops that need to be
fixed.

Any locations that have an unresolved traceroute or ping must be examined and fixed.

Use network packet sniffing to ensure traffic is being routed as you expect.

Verifying the dual-homed side of the configuration

Since there are two connections to the Internet in this example, theoretically you can pull the plug on one of the
ISP connections, and all traffic will go through the other connection. Alternately, you may choose to remove a
default route to one ISP, remove that ISP’s neighbor settings, or change the weightings to prefer the other ISP.
These alternate ways to test dual-homing do not change physical cabling, which may be preferred in some
situations.

If this does not work as expected, things to check include:

l Default static routes: If these are wrong or do not exist, the traffic cannot get out.
l BGP neighbor information: If the ISP router information is incorrect, the FortiGate unit will not be able to talk to it.

Redistributing and blocking routes in BGP
During normal BGP operation, peer routers redistribute routes from each other. However, in some specific
situations it may be best not to advertise routes from one peer, such as if the peer is redundant with another peer
(they share the same routes exactly), if it might be unreliable in some way or for some other reason. The
FortiGate can also take routes it learns from other protocols and advertise them in BGP, for example OSPF or
RIP. If your company hosts its own web or email servers, external locations will require routes to your networks to
reach those services.

In this example, the company has an internal network in an OSPF area and is connected to a BGP AS and two
BGP peers. The company goes through these two peers to reach the Internet. However, Peer 1 routes will not be
advertised to Peer 2. The company internal user and server networks are running OSPF, and will redistribute
those routes to BGP so external locations can reach the web and email servers.

Network layout and assumptions

The network layout for the BGP redistributing routes example involves the company network being connected to
two BGP peers, as shown below. In this configuration, the FortiGate unit is the BGP border router between the
Company AS and the peer routers.

The components of the layout include:

l There is only one BGP AS in this example shared by the FortiGate unit and both peers: AS 65001.
l The company’s FortiGate unit connects to the Internet through two BGP peers.
l The company's internal networks on the dmz interface of the FortiGate unit with an IP of 10.11.201.0/24.
l The FortiGate unit's interfaces are connected as follows:
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l port1 (dmz) has IP 10.11.201.110 and is the internal user and server network
l port2 (external1) has IP 172.21.111.4 and is connected to Peer 1’s network
l port3 (external2) has IP 172.22.222.4 and is connected to Peer 2’s network

l Peer 1 has IP 172.21.111.5, and Peer 2 has IP 172.22.222.5.
l OSPF Area 1 is configured on the dmz interface of the FortiGate unit, and is the routing protocol used by the

internal users and servers.

BGP network topology

Assumptions

The BGP redistributing routes configuration procedure follows these assumptions:

l The FortiGate unit has been configured following the Install Guide
l Interfaces port1, port2, and port3 exist on the FortiGate unit
l We do not know the router manufacturers of Peer 1 and Peer 2
l We do not know what other devices are on the BGP AS or OSPF Area
l All basic configuration can be completed in both GUI and CLI
l Access lists and route maps will only be configured in CLI
l VDOMs are not enabled on the FortiGate unit

Configuring the FortiGate unit

1. Configuring networks and firewalls on the FortiGate unit
2. Configuring BGP on the FortiGate unit
3. Configuring OSPF on the FortiGate unit
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4. Configuring other networking devices
5. Configuring ECMP support for BGP

Configuring networks and firewalls on the FortiGate unit

The FortiGate unit has three interfaces connected to networks: two external and one dmz.

Security policies must be in place to allow traffic to flow between these networks.

Firewall services will change depending on which routing protocol is being used on that network: either BGP or
OSPF. Beyond that, all services that are allowed will be allowed in both directions due to the internal servers. The
services allowed are web server services (DNS, HTTP, HTTPS, SSH, NTP, FTP*, SYSLOG, and MYSQL), email
services (POP3, IMAP, and SMTP), and general troubleshooting services (PING, TRACEROUTE). To increase
security, PING and TRACEROUTE can be removed once the network is up and working properly. Other services
can be added later, as needed.

To configure the interfaces - web-based manager

1. Go to Network > Interfaces.
2. Edit port1 (dmz) interface.
3. Set the following information and select OK.

Alias dmz

IP/Network Mask 10.11.201.110/255.255.255.0

Administrative Access HTTPS SSH PING

Description OSPF internal networks

Administrative Status Up

4. Edit port2 (external1) interface.
5. Set the following information and select OK.

Alias external1

IP/Network Mask 172.21.111.4/255.255.255.0

Administrative Access HTTPS SSH

Description BGP external Peer 1

Administrative Status Up

6. Edit port3 (external2) interface.
7. Set the following information and select OK.

Alias external2
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IP/Network Mask 172.22.222.4/255.255.255.0

Administrative Access HTTPS SSH

Description BGP external2 Peer2

Administrative Status Up

To configure the FortiGate interfaces - CLI

config system interface
edit port1

set alias dmz
set ip 10.11.201.110 255.255.255.0
set allowaccess https ssh ping
set description "OSPF internal networks"
set status up

next
edit port2

set alias external1
set ip 172.21.111.5 255.255.255.0
set allowaccess https ssh
set description "external1 Peer 1"
set status up

next
edit port3

set alias external2
set ip 172.22.222.5 255.255.255.0
set allowaccess https ssh
set description "external2 Peer 2"
set status up

next
end

To configure the firewall addresses - web-based manager

1. Go to Policy & Objects > Objects > Addresses.
2. Select Create New and set the following information.

Category Address

Name BGP_services

Type Subnet / IP Range

Subnet / IP Range 10.11.201.0 255.255.255.0

Interface port1

3. Select OK.
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To configure the firewall addresses - CLI

config firewall address
edit "BGP_services"

set associated-interface "port1"
set subnet 10.11.201.0 255.255.255.0

next
end

To configure firewall service groups - web-based manager

1. Go to Policy & Objects > Objects > Services. Under the Create New dropdown menu, select Service
Group.

2. Name the group BGP_Services.
3. Add the following services to theMembers list: BGP, DNS, FTP, FTP_GET, FTP_PUT, HTTP, HTTPS, IMAP,

MYSQL, NTP, PING, POP3, SMTP, SSH, SYSLOG, and TRACEROUTE.
4. Select OK.
5. Create another new Service Group.
6. Name the group OSPF_Services.
7. Add the following services to theMembers list: DNS, FTP, FTP_GET, FTP_PUT, HTTP, HTTPS, IMAP, MYSQL,

NTP, OSPF, PING, POP3, SMTP, SSH, SYSLOG, and TRACEROUTE.
8. Select OK.

To configure firewall service groups - CLI

config firewall service group
edit "BGP_services"

set member "BGP", "DHCP" "DNS" "FTP" "FTP_GET" "FTP_PUT" "HTTP" "HTTPS" "IMAP"
"MYSQL" "NTP" "PING" "POP3" "SMTP" "SSH" "TRACEROUTE" "SYSLOG"

next
edit "OSPF_services"

set member "DHCP" "DNS" "FTP" "FTP_GET" "FTP_PUT" "HTTP" "HTTPS" "IMAP" "MYSQL"
"NTP" "PING" "POP3" "SMTP" "SSH" "TRACEROUTE" "SYSLOG" "OSPF"

next
end

Configuring BGP on the FortiGate unit

The only change from the standard BGP configuration for this example is configuring the blocking Peer 1’s routes
from being advertised to Peer 2. From the network topology you can guess that both of these peers likely share
many routes in common and it does not make sense to advertise unneeded routes.

Blocking Peer 1’s routes to Peer 2 is done with the distribute-list-out keyword. They allow you to select which
routes you will advertise to a neighbor using an access list. In this case, we will block all incoming routes from
Peer 1 when we send updates to Peer 2. Otherwise Peer 1 and Peer 2 are regular neighbors.

The FortiGate unit will redistribute routes learned from OSPF into BGP.

This is advanced configuration and the commands are only available in the CLI.

To create access list to block Peer 1 - CLI

config access-list
edit "block_peer1"
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config rule
edit 1

set prefix 172.21.111.0 255.255.255.0
set action deny
set exact-match enable

end
end

end

To configure BGP on the FortiGate unit - CLI

config router bgp
set as 65001

set router-id 10.11.201.110
config redistribute ospf

set status enable
end
config neighbor
edit 172.22.222.5

set remote-as 65001
set distribute-list-out "block_peer1"

next
edit 172.21.111.5

set remote-as 65001
end

end

Configuring OSPF on the FortiGate unit

This configuration involves only one OSPF area, so all traffic will be intra-area. If there were two or more areas
with traffic going between them, it would be inter-area traffic. These two types are comparable to BGP’s traffic
within one AS (iBGP) or between multiple ASes (eBPG). Redistributing routes from OSPF to BGP is considered
external because either the start or end point is a different routing protocol.

The OSPF configuration is basic, apart from redistributing BGP routes learned.

To configure OSPF on the FortiGate unit - web-based manager

1. Go to Router > Dynamic > OSPF.
2. For Router ID enter 10.11.201.110 and then select Apply.
3. UnderAdvanced Options >Redistribute, select BGP and set the BGPMetric to 1.
4. ForAreas, select Create New, enter the following information and then select OK.

Area (IP) 0.0.0.0

Type Regular

Authentication None

5. ForNetworks, select Create New.
6. Enter 10.11.201.0/255.255.255.0 for IP/Netmask, and select OK.
7. For Interfaces, select Create New.
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8. Enter OSPF_dmz_network forName.
9. Select port1(dmz) for Interface and then select OK.

To configure OSPF on the FortiGate unit - CLI

config router ospf
set router-id 10.11.201.110
config area

edit 0.0.0.0
set type regular
set authentication none

end
config network

edit 1
set area 0.0.0.0
set prefix 10.11.201.0 255.255.255.0

end
config interface

edit "OSPF_dmz_network"
set interface port1(dmz)
set status enable

end
config redistribute bgp

set status enable
set metric 1

end
end

Configuring other networking devices

As with all BGP configurations, the peer routers will need to be updated with the FortiGate unit’s BGP
information, including IP address, AS number, and what capabilities are being used, such as IPv6, graceful
restart, BFD, and so on.

Configuring ECMP support for BGP

Equal Cost Multiple Path (ECMP) is a mechanism that allows multiple routes to the same destination with
different next-hops and load-balances routed traffic over those multiple next-hops.

l ECMP only works for routes that are sourced by the same routing protocol (Static Routes, OSPF, and BGP).
l ECMP is enabled, by default, with 10 paths.
l ECMPwith static routes is effective if the routes are configured with the same distance and same priority.

To configure ECMP support - CLI

config router bgp
set ebgp-multipath disable[|enable]
set ibgp-multipath disable[|enable]
...

end

Testing network configuration

Testing this configuration involves the standard connectivity checks, but also ensures that routes are being
passed between protocols as expected.
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Check the routing table on the FortiGate unit to ensure that routes from both OSPF and BGP are present.

Check the routing table on devices on the OSPF network for routes redistributed from BGP. Also, check those
devices for connectivity to the Internet.

Check the routing table on Peer 2 to ensure that no routes from Peer 1 are present, but routes from the internal
OSPF network are present.

For help with troubleshooting, see Redistributing and blocking routes in BGP on page 2629.
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IS-IS

This section describes the Intermediate System to Intermediate System Protocol (IS-IS).

IS-IS background and concepts
Intermediate System to Intermediate System Protocol (IS-IS) allows routing of ISO’s OSI protocol stack
Connectionless Network Service (CLNS). IS-IS is an Interior Gateway Protocol (IGP) that is not intended to be
used between Autonomous Systems (AS).

Background

IS-IS was developed by Digital Equipment Corporation and later standardized by ISO in 1992 as ISO 19589 (see
RFC 1142, note that this RFC is different from the ISO version). About the same time, the Internet Engineering
Task Force developed OSPF (see OSPF on page 2557). After the initial version, IP support was added to IS-IS
and this version was called Integrated IS-IS (see RFC 1195). Its widespread use started when an early version of
IS-IS was included with BSD v4.3 Linux as the routed daemon. The routing algorithm used by IS-IS, the Bellman–
Ford algorithm, first saw widespread use as the initial routing algorithm of the ARPANET.

IS-IS is a link state protocol that is well-suited to smaller networks. It is in widespread use and has near universal
support on routing hardware. It is quick to configure and works well if there are no redundant paths. However, IS-
IS updates are sent out node-by-node, so it can be slow to find a path around network outages. IS-IS also lacks
good authentication, cannot choose routes based on different quality of service methods, and can create network
loops if you are not careful. IS-IS uses Djikstra’s algorithm to find the best path, like OSPF.

While OSPF is more widely known, IS-IS is a viable alternative to OSPF in enterprise networks and ISP
infrastructures, largely due to its native support for IPv6 and its non-disruptive methods for splitting, merging,
migrating, and renumbering network areas.

The FortiGate implementation supports IS-IS for IPv4 (see RFCs 1142 and 1162), but does not support IS-IS for
IPv6 (although this technically can be achieved using the ZebOS routing module).

How IS-IS works
As one of the original modern dynamic routing protocols, IS-IS is straightforward. Its routing algorithm is not
complex, there are some options to allow fine-tuning, and it is straightforward to configure IS-IS on FortiGate
units.

From RFC 1142:

The routing algorithm used by the Decision Process is a shortest path first (SPF) algorithm.
Instances of the algorithm are run independently and concurrently by all intermediate systems in a
routing domain. IntraDomain routing of a PDU occurs on a hop-by-hop basis: that is, the algorithm
determines only the next hop, not the complete path, that a data PDU will take to reach its
destination.

IS-IS versus static routing

IS-IS was one of the earliest dynamic routing protocols to work with IP addresses. As such, it is not as complex as
more recent protocols. However, IS-IS is a big step forward from simple static routing.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2637

http://tools.ietf.org/html/rfc1142
http://tools.ietf.org/html/rfc1195
http://tools.ietf.org/html/rfc1142
http://tools.ietf.org/html/rfc1162
http://tools.ietf.org/html/rfc1142


IS-IS

While IS-IS may be slow in response to network outages, static routing has zero response. The same is true for
convergence: static routing has zero convergence. Both IS-IS and static routing have the limited hop count, so it
is neither a strength or a weakness.

TLV

IS-IS uses type-length-variable (TLV) parameters to carry information in Link-State PDUs (LSPs). Each IS-IS LSP
consists of a variable-length header to which TLVs are appended in order to extend IS-IS for IP routing. The TLV
field consists of one octet of type (T), one octet of length (L), and “L” octets of value (V). They are included in all of
the IS-IS Packet types. For a complete breakdown of the LSP, see LSP structure on page 2638.

In IS-IS, TLVs are used to determine route-leaking and authentication and are also used for IPv4 and IPv6
awareness and reachability.

l To determine which TLVs are responsible for route-leaking, see Default routing on page 2640.
l To determine which TLVs are responsible for authentication, see Authentication on page 2642.

For a complete list of reserved TLV codepoints, refer to RFC 3359.

LSP structure

It is difficult to fully understand a routing protocol without knowing what information is carried in its packets.
Knowing how routers exchange each type of information will help you better understand the IS-IS protocol and
will allow you to configure your network more appropriately.

This section provides information about the contents of the IS-IS LSP. LSPs describe the network topology and
can include IP routes and checksums.

NSAP and NET

IS-IS routing protocol utilizes ISO network addressing to identify network interfaces. The addresses are known as
Network Service Access Points (NSAP). In general, IS-IS routers consist of only one NSAP, whereas IP
addressing requires one IP address per interface.

In IS-IS, the NSAP address is translated into a Network Entity Title (NET), which is the same as the NSAP but can
differentiate end systems by way of a byte called the n-selector (NSEL). In order for adjacencies to form in IS-IS,
the NSEL must be set to zero, to indicate “this system”. The total NET can be anywhere between 8 and 20 bytes
long due to the support for variable length area addressing.

The following diagram identifies the individual parts of the NSAP, with explanations below:

NSAP and NET example
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l AFI : The Authority and Format Identifier (AFI) specifies the format of the addressing family used. IS-IS is
designed to carry routing information for several different protocols. Each entry has an address family identifier that
identifies the globally unique Interdomain Part (IDP). For example, 49 is the AFI for private addresses, whereas 47
is the AFI for international organizations.

l IDI: The Initial Domain Identifier (IDI) identifies the routing domain within an interconnected network. The length of
the IDI is typically determined by the AFI. If you are using an AFI of 49, you do not need to specify an IDI since the
network is private.

l HODSP : The HighOrder Domain-Specific Part (HODSP) identifies the unique address within a specific routing
domain. Together, the AFI, IDI, and HODSP define the area address. All of the nodes within an area must have the
same area address.

l System ID : The System ID represents the 6-8 byte router identifier. The ID could be Media Access Control (MAC)
format, as in the example above, or a static length IP address expressed in binary-coded decimal (BCD) format.

l NSEL: The n-selector (NSEL), as previously described, identifies the network layer transport service and must
always be set to zero for IS-IS NETs.

Parts and terminology of IS-IS

Before you can understand how IS-IS functions, you need to understand some of the main concepts and parts of
IS-IS.

DIS election and pseudonode LSP

In IS-IS routing protocol, a single router is chosen to be the designated intermediate system (DIS). The election
of the DIS is determined automatically and dynamically on the LAN depending on highest interface priority and
the subnetwork point of attachment (SNPA). The FortiGate is typically the DIS, and each router in its LAN is an
intermediate system (IS).

Unlike OSPF, which elects a designated router (DR) and backup designated router (BDR), the DIS has no backup
and determines the election of a new DIS whenever a router is added to the LAN or whenever the current DIS
drops. A backup DIS is irrelevant since all of the routers on an IS-IS system are synchronized, and the short Hello
interval used by the DIS quickly detects failures and the subsequent replacement of the DIS.

Synchronization of all the nodes in an IS-IS area could prove troublesome when updating the network
infrastructure and would demand ever-increasing resources each time a new router is added (at an exponential
scale). For this purpose, the DIS creates a pseudonode, which is essentially a virtual, logical node representing
the LAN. The pseudonode requests adjacency status from all the routers in a multi-access network by sending IS-
IS Hello (IIH) PDUs to Level 1 and Level 2 routers (where Level 1 routers share the same address as the DIS and
Level 2 routers do not). Using a pseudonode to alter the representation of the LAN in the link-state database
(LSD) greatly reduces the amount of adjacencies that area routers have to report. In essence, a pseudonode
collapses a LAN topology, which allows a more linear scale to link-state advertising.

In order to maintain the database synchronization, the DIS periodically sends complete sequence number
packets (CSNPs) to all participating routers.

Packet types

Four general packet types (PDUs) are communicated through IS-IS, appearing at both Level 1 and Level 2. They
are described below.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2639



IS-IS

l Intermediate System-to-Intermediate System Hello (IIH) PDU : As mentioned previously, the IIH PDU, or
Hello packet, detects neighboring routers and indicates to the pseudonode the area’s adjacency mesh. The Hello
packet, flooded to the multicast address, contains the system ID of the sending router, the holding time, the circuit
type of the interface on which the PDU was sent, the PDU length, the DIS identifier, and the interface priority (used
in DIS election). The Hello packet also informs its area routers that it is the DIS. Hello packets are padded to the
maximum IS-IS PDU size of 1492 bytes (the full MTU size) to assist in the detection of transmission errors with
large frames or with MTUmismatches between adjacencies. The DIS typically floods Hello packets to the entire
LAN every three seconds.

l Link-state PDU (LSP) : The LSP contains information about each router in an area and its connected interfaces.
LSPs are refreshed periodically and acknowledged on the network by way of sequence number PDUs. If new LSP
information is found, based on the most recent complete sequence number PDU (CSNP), out-of-date entries in the
link-state database (LSDB) are removed and the LSDB is updated. For a more detailed breakdown of the LSP, see
LSP structure on page 2638.

l Complete sequence number PDU (CSNP): CSNPs contain a list of all LSPs in the current LSDB. The CSNP
informs other area routers of missing or outdated links in the adjacency mesh. The receiving routers then use this
information to update their own database to ensure that all area routers converge. In contrast to Hello packets,
CSNPs are sent every ten seconds and only between neighbors. In other words, they are never flooded.

l Partial sequence number PDU (PSNP) : PSNPs are used to request and acknowledge LSP information from an
adjacency. When a router compares a CSNPwith its local database and determines a discrepancy, the router
requests an updated LSP using a PSNP. Once received, the router stores the LSP in its local database and
responds to the DIS with acknowledgement.

Default routing

The default route is used if there are no other routes in the routing table or if none of the other routes apply to a
destination. Including the gateway in the default route gives all traffic a next-hop address to use when leaving the
local network. The gateway address is normally another router on the edge of the local network.

FortiGate units come with a default static route with an IPv4 address of 0.0.0.0, an administration distance of 10,
and a gateway IPv4 address. Beginner administrators can use the default route settings until a more advanced
configuration is warranted.

By default, all routes are displayed in the Routing Monitor list. To display the routes in the routing table, go to
Monitor > Routing Monitor.

Route leaking

Route leaking is the term used to describe the bi-directional flow of information between internal and external
routing interfaces. By default, IS-IS leaks routing information from a Level 1 area into a Level 2 area. In order to
leak Level 2 routing information into a Level 1 area, you must configure an export policy. Whether or not a route is
leaked is determined by the ATT bit, using TLV 128 (for internal IP reachability) and TLV 130 (for external IP
address information). For more information about TLVs, see Troubleshooting IS-IS on page 2643.

To configure IS-IS route leaking, use the following CLI commands.

1. On a Level 1-2 router:
config router isis

set redistribute-l2 enable
end

2. You can use the following commands to show the results:
get router info routing-table isis
get router info isis route
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Default information originate option

Enabling default-information-originate generates and advertises a default route into the FortiGate unit’s IS-IS-
enabled networks. The generated route may be based on routes learned through a dynamic routing protocol,
routes in the routing table, or both. IS-IS does not create the default route unless you use the always option.

Select Disable if you experience any issues or if you wish to advertise your own static routes into IS-IS updates.

The CLI commands associated with default information originate include:

config router isis
set default-originate

end

Timer options

IS-IS uses various timers to regulate its performance, including garbage, update, and timeout timers. The
FortiGate unit default timer settings (30, 180, and 120 seconds respectively) are effective in most configurations.
If you change these settings, ensure that the new settings are compatible with local routers and access servers.

You can configure the three IS-IS timers in the CLI, using the following commands:

config router isis
set garbage-timer
set update-timer
set timeout-timer

end

You will find more information on each timer below.

Update timer

The update timer determines the interval between routing updates. Generally, this value is set to 30 seconds.
There is some randomness added to help prevent network traffic congestion, which could result from all routers
simultaneously attempting to update their neighbors. The update timer should be at least three times smaller
than the timeout timer, or you will experience an error.

If you are experiencing significant traffic on your network, you can increase this interval to send fewer updates per
minute. However, ensure you increase the interval for all the routers on your network or you will experience
timeouts that will degrade your network speed.

Timeout timer

The timeout timer is the maximum amount of time (in seconds) that a route is considered reachable while no
updates are received for the route. This is the maximum time the DIS will keep a reachable route in the routing
table while no updates for that route are received. If the DIS receives an update for the route before the timeout
period expires, the timer is restarted. The timeout period should be at least three times longer than the update
period, or you will experience an error.

If you are experiencing problems with routers not responding in time to updates, increase this timer. However,
remember that longer timeout intervals result in longer overall update periods. It may be a considerable amount
of time before the DIS is done waiting for all the timers to expire on unresponsive routes.
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Garbage timer

The garbage timer is the amount of time (in seconds) that the DIS will advertise a route as being unreachable
before deleting the route from the routing table. If this timer is shorter, it will keep more up-to-date routes in the
routing table and remove old ones faster. This results in a smaller routing table, which is useful if you have a very
large network or if your network changes frequently.

Authentication

In routing protocols, it is typically desirable to establish authentication rules that prevent malicious and otherwise
unwanted information from being injected into the routing table. IS-IS routing protocol utilizes TLV 10 to establish
authentication. For more information about TLVs, see TLV on page 2638.

Initially, IS-IS used plain cleartext to navigate the authentication rules, but this was found to be insecure since the
cleartext packets were unencrypted and could be exposed to packet sniffers. As per RFC 3567, HMAC-MD5 and
enhanced cleartext authentication features were introduced in IS-IS, both of which encrypt authentication data,
making them considerably more secure than using plain cleartext authentication.

HMAC-MD5 authentication

Hashed Message Authentication Codes - Message Digest 5 (HMAC-MD5) is a mechanism for applying a
cryptographic hash function to the message authentication process. It is applied at both Level 1 and Level 2
routing. In IS-IS, an HMAC-MD5 can be applied to each type of LSP, on different interfaces, and with different
passwords.

Authentication data is hashed using an AH (Authentication Header) key. From RFC 2085:

The “AH Key” is used as a shared secret between two communicating parties. The Key is not a
“cryptographic key” as used in a traditional sense. Instead, the AH key (shared secret) is hashed
with the transmitted data and thus, assures that an intervening party cannot duplicate the
authentication data. [...] Implementation should, and as frequently as possible, change the AH key.
Keys need to be chosen at random, or generated using a cryptographically strong pseudo-random
generator seeded with a random seed.”

Cleartext authentication uses the configuration commands area-password and domain-password for
authentication, but when migrating from cleartext authentication to HMAC-MD5, these command settings are
automatically overwritten.

By the year 2005, the MD5 hash function had been identified as vulnerable to collision search attacks and various
weaknesses. While such vulnerabilities do not compromise the use of MD5 within HMAC, administrators need to
be aware of potential developments in cryptanalysis and cryptographic hash functions in the likely event that the
underlying hash function needs to be replaced.

Enhanced cleartext authentication

Enhanced cleartext authentication is an extension to cleartext authentication that allows the encryption of
passwords as they are displayed in the configuration. It includes a series of authentication mode commands and
an authentican key chain, and allows for more simple password modification and password management.
Enhanced cleartext authentication also provides for smoother migration to and from changing authentication
types. Intermediate systems continue to use the original authentication method until all the area routers are
updated to use the new method.
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Authentication key chain

A key chain is a list of one or more authentication keys including the send and receive lifetimes for each key. Keys
are used for authenticating routing packets only during the specified lifetimes. A router migrates from one key to
the next according to the scheduled send and receive lifetimes. If an active key is unavailable, the PDU is
automatically discarded.

From RFC 5310:

It should be noted that the cryptographic strength of the HMAC depends upon the cryptographic
strength of the underlying hash function and on the size and quality of the key.

Troubleshooting IS-IS

Routing loops

Normally in routing, a path between two addresses is chosen and traffic is routed along that path from one
address to the other. When there is a routing loop, that normal path doubles back on itself creating a loop. When
there are loops, the network has problems.

A routing loop happens when a normally functioning network has an outage and one or more routers are offline.
When packets encounter this, an alternate route is attempted to maneuver around the outage. During this phase
it is possible for a route to be attempted that involves going back a hop and trying a different hop forward. If that
hop forward is blocked by the outage as well, a hop back and possibly the original hop forward may be selected.
You can see if this continues, how it can consume not only network bandwidth but also many resources on the
affected routers. The worst part is this situation will continue until the network administrator changes the router
settings or the downed routers come back online.

Routing loop effect on the network

In addition to this “traffic jam” of routed packets, every time the routing table for a router changes that router
sends an update out to all of the IS-IS routers connected to it. In a network loop, it is possible for a router to
change its routes very quickly as it tries and fails along these new routes. This can quickly result in a flood of
updates being sent out, which can effectively grind the network to a halt until the problem is fixed.

How to spot a routing loop

Any time network traffic slows down, you will ask yourself if it is a network loop or not. Often slowdowns are
normal. They are not a full stoppage and normal traffic resumes in a short period of time.

If the slowdown is a full halt of traffic, or a major slowdown does not return to normal quickly, you need to do
serious troubleshooting quickly.

Some methods to troubleshoot your outage include:

l Checking your logs
l Using SNMP network monitoring
l Using Link Health Monitor and e-mail alerts
l Looking at the packet flow

If you are not running SNMP or dead gateway detection, or if you have non-Fortinet routers in your network, you
can use networking tools such as ping and traceroute to define the outage on your network and begin to fix it.
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Checking your logs

If your routers log events to a central location, it can be easy to check the logs for your network for any outages.

On your FortiGate unit, go to Log & Report > Log & Archive Access. You will want to look at both event logs
and traffic logs. Events to look for will generally fall under CPU and memory usage, interfaces going offline (due
to dead gateway detection), and other similar system events.

Once you have found and fixed your network problem, you can go back to the logs and create a report to better
see how things developed during the problem. This type of forensic analysis can better help you prepare for next
time.

Using SNMP network monitoring

If your network had no problems one minute and slows to a halt the next, chances are something changed to
cause that problem. Most of the time an offline router is the cause and once you find that router and bring it back
online, things will return to normal.

If you can enable a hardware monitoring system such as SNMP or sFlow on your routers, you can be notified of
the outage and where it is exactly, as soon as it happens.

Ideally you can configure SNMP on all your FortiGate routers and be alerted to all outages as they occur.

To use SNMP to detect potential routing loops

1. Go to System > Config > SNMP.
2. Enable SNMP Agent.
3. Optionally enter the Description, Location, and Contact information for this device for easier location of the

problem report.
4. In either SNMP v1/v2c section or SNMP v3 section, as appropriate, select Create New.
5. Enter the Community Name that you want to use.
6. In Hosts, select Add to add an IP address where you will be monitoring the FortiGate unit. You can add up to 8

different addresses.
7. Ensure that ports 161 and 162 (SNMP queries and traps) are allowed through your security policies.
8. In SNMP Event, select the events you want to be notified about. For routing loops, this should include

CPU Overusage, Memory Low, and possibly Log disk space low. If there are problems, the log will fill up
quickly, and the FortiGate unit’s resources will be overused.

9. Select OK.
10. Configure SNMP host (manager) software on your administration computer. This will monitor the SNMP

information sent out by the FortiGate unit. Typically, you can configure this software to alert you about outages or
CPU spikes that may indicate a routing loop.

Using Link Health Monitor and e-mail alerts

Another tool available to you on FortiGate units is the Link Health Monitor. This is useful for dead gateway
detection. This feature allows the FortiGate unit to ping a gateway at regular intervals to ensure it is online and
working. When the gateway is not accessible, that interface is marked as down.

To detect possible routing loops with Link Health Monitor

Use the following command to configure dead gateway detection:

config system link-monitor
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edit "test"
set srcintf "internal4"
set server "8.8.8.8"
set interval 5
set failtime 1

end

Set the Interval (how often to send a ping) and failtime (how many lost pings is considered a failure). A
smaller interval and smaller number of lost pings will result in faster detection, but will create more traffic on your
network.

You may also want to log CPU and memory usage, as a network outage will cause your CPU activity to spike.

If you have VDOMs configured, you will have to enter the basic SMTP server information in the Global
section, and the rest of the configuration within the VDOM that includes this interface.

After this configuration, when this interface on the FortiGate unit cannot connect to the next router, the FortiGate
unit will bring down the interface and alert you with an email about the outage.

Looking at the packet flow

If you want to see what is happening on your network, look at the packets travelling on the network. In this
situation, you are looking for routes that have metrics higher than 15 as that indicates they are unreachable.
Ideally if you debug the flow of the packets, and record the routes that are unreachable, you can create an
accurate picture of the network outage.

Action to take on discovering a routing loop

Once you have mapped the problem on your network and determined it is in fact a routing loop, there are a
number of steps to take to correct it.

1. Get any offline routers back online. This may be a simple reboot or you may have to replace hardware. Often this
first step will restore your network to its normal operation, once the routing tables finish being updated.

2. Change your routing configuration on the edges of the outage. Even if step 1 brought your network back online,
you should consider making changes to improve your network before the next outage occurs. These changes can
include configuring features like holddowns and triggers for updates, split horizon, and poison reverse updates.

Split horizon and poison reverse updates

Split horizon is best explained with an example. You have three routers linked serially, let us call them routerA,
routerB, and routerC. RouterA is linked only to routerB, routerC is linked only to routerB, and routerB is linked to
both routerA and routerC. To get to routerC, routerAmust go through routerB. If the link to routerC goes down, it
is possible that routerB will try to use routerA’s route to get to routerC. This route is A-B-C, so it will not work.
However, if routerB tries to use it, this begins an endless loop. This situation is called a split horizon because from
routerB’s point of view, the horizon stretches out in each direction but in reality it only is on one side.

Poison reverse is the method used to prevent routes from running into split horizon problems. Poison reverse
“poisons” routes away from the destination that use the current router in their route to the destination. This
“poisoned” route is marked as unreachable for routers that cannot use it. In IS-IS, this means that route is marked
with a distance of 16.

Simple IS-IS example
This is an example of a typical medium-sized network configuration using IS-IS routing.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2645



IS-IS

Imagine a company with four FortiGate devices connected to one another. A FortiGate at one end of the network
connects to two routers, each with its own local subnet. One of these routers uses OSPF and the other router
uses RIP.

Your task is to configure the four FortiGates to route traffic and process network updates using IS-IS, so that the
farthest FortiGate (see ‘FGT4’ in Network layout and assumptions on page 2646) receives route updates for the
two routers at the opposite end of the network. Furthermore, FGT4 has been given a loopback subnet that must
be identified by the router running RIP.

Since the internal networks use OSPF and RIP, those protocols will need to be redistributed through the IS-IS
network. To keep the example simple, there will be no authentication of router traffic.

With IS-IS properly configured in this example, if a router fails or temporarily goes offline, the route change will
propagate throughout the system.

Network layout and assumptions
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FGT3FGFGT3

FGT4

Routing domains

FGFGFGFGT1

FGT2

RIP
domain
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2646 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



IS-IS

FGT1

FGT2

FGT3FGFGFGT3

FGT4

RTR2

RTR1

IP scheme and interfaces
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◄

◄

l It is assumed that each FortiGate is operating in NAT mode, running FortiOS 4.0MR2+.
l All interfaces have been previously assigned and no static routes are required.
l The Authority and Format Identifier (AFI) used is 49 : Locally administered (private).
l The Area identifiers are 0048 and 0049.

Expectations
l FGT4 must get the IS-IS route updates for RTR1 and RTR2 local subnets (10.1.1.0, 10.2.2.0, 10.3.3.0, 10.4.4.0).
l RTR1 must receive (via RIP2) the loopback subnet of FGT4 (10.60.60.1/32).

CLI configuration
The following CLI configuration occurs on each FortiGate (as identified), including only the relevant parts.

FGT1

config router isis
config isis-interface

edit "port3"
set circuit-type level-1
set network-type broadcast
set status enable

next
end
config isis-net

edit 1
set net 49.0048.1921.6818.2136.00

next
end
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config redistribute "connected"
end
config redistribute "rip"

set status enable
set level level-1

end
config redistribute "ospf"

set status enable
set level level-1

end
end
config router rip

config interface
edit "port2"

set receive-version 2
set send-version 2

next
end
config network

edit 1
set prefix 10.10.10.0 255.255.255.0

next
end
config redistribute "isis"

set status enable
end

end

FGT2

config router isis
config isis-interface

edit "port3"
set circuit-type level-1
set network-type broadcast
set status enable

next
edit "port2"

set network-type broadcast
set status enable

next
end
config isis-net

edit 1
set net 49.0048.1221.6818.2110.00

next
end
set redistribute-l1 enable
set redistribute-l2 enable

end

FGT3

config router isis
set is-type level-2-only
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config isis-interface
edit "wan1"

set network-type broadcast
set status enable

next
edit "dmz1"

set network-type broadcast
set status enable

next
end
config isis-net

edit 1
set net 49.0048.1921.6818.2108.00

next
edit 2

set net 49.0049.1921.6818.2108.00
next

end
end

FGT4

config router isis
set is-type level-2-only

config isis-interface
edit "wan1"

set network-type broadcast
set status enable

next
end
config isis-net

edit 1
set net 49.0049.1721.0160.1004.00

next
end
config redistribute "connected"

set status enable
end

end

Verification
Once the network has been configured, you need to test that it works as expected. Use the following CLI
commands on the devices indicated.

Verifying if RTR1 receives loopback subnet of FGT4

(RTR1) # get router info routing-table all

Result:

C    10.1.1.0/24 is directly connected, vlan1
C    10.2.2.0/24 is directly connected, vlan2
C    10.10.10.0/24 is directly connected, dmz1
R    10.40.40.0/24 [120/2] via 10.10.10.1, dmz1, 00:04:07
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R    10.50.50.0/24 [120/2] via 10.10.10.1, dmz1, 00:04:07
R    10.60.60.1/32 [120/2] via 10.10.10.1, dmz1, 00:04:07
(*) If required, filtering out 10.50.50.0 and 10.40.40.0 from the routing table could be done with a route-map.

Verification on FGT2, which is the border between L1 and L2 routing levels; looking at IS-IS information

FGT2 # get router info isis interface

Result:

port2 is up, line protocol is up
Routing Protocol: IS-IS ((null))
Network Type: Broadcast
Circuit Type: level-1-2
Local circuit ID: 0x01
Extended Local circuit ID: 0x00000003
Local SNPA: 0009.0f85.ad8c
IP interface address:
10.40.40.2/24
IPv4 interface address:
Level-1 Metric: 10/10, Priority: 64, Circuit ID: 1221.6818.2110.01
Number of active level-1 adjacencies: 0
Level-2 Metric: 10/10, Priority: 64, Circuit ID: 1221.6818.2110.01
Number of active level-2 adjacencies: 1
Next IS-IS LAN Level-1 Hello in 6 seconds
Next IS-IS LAN Level-2 Hello in 1 seconds
port3 is up, line protocol is up
Routing Protocol: IS-IS ((null))
Network Type: Broadcast
Circuit Type: level-1
Local circuit ID: 0x02
Extended Local circuit ID: 0x00000004
Local SNPA: 0009.0f85.ad8d
IP interface address:
10.30.30.2/24
IPv4 interface address:
Level-1 Metric: 10/10, Priority: 64, Circuit ID: 1221.6818.2110.02
Number of active level-1 adjacencies: 1
Next IS-IS LAN Level-1 Hello in 2 seconds

FGT2 # get router info isis neighbor

Result:

System Id Interface SNPA State Holdtime Type Protocol

1921.6818.2108 port2 0009.0f04.0794 Up 22 L2 IS-IS

1921.6818.2136 port3 0009.0f85.acf7 Up 29 L1 IS-IS

Verification on FGT3, which is border between 2 areas, looking at IS-IS information

IS-IS router CLI commands available:
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FGT3 # get router info isis ?

Result:

interface show isis interfaces

neighbour show CLNS neighbor adjacencies

is-neighbour show IS neighbor adjacencies

database show IS-IS link state database

route show IS-IS IP routing table

topology show IS-IS paths

Example of interface status and neighbors:

FGT3 # get router info isis interface

Result:

wan1 is up, line protocol is up
Routing Protocol: IS-IS ((null))
Network Type: Broadcast
Circuit Type: level-1-2
Local circuit ID: 0x01
Extended Local circuit ID: 0x00000003
Local SNPA: 0009.0f04.0794
IP interface address:
10.40.40.1/24
IPv4 interface address:
Level-2 Metric: 10/10, Priority: 64, Circuit ID: 1221.6818.2110.01
Number of active level-2 adjacencies: 1
Next IS-IS LAN Level-2 Hello in 3 seconds

dmz1 is up, line protocol is up
Routing Protocol: IS-IS ((null))
Network Type: Broadcast
Circuit Type: level-1-2
Local circuit ID: 0x02
Extended Local circuit ID: 0x00000005
Local SNPA: 0009.0f04.0792
IP interface address:
10.50.50.1/24
IPv4 interface address:
Level-2 Metric: 10/10, Priority: 64, Circuit ID: 1721.0160.1004.01
Number of active level-2 adjacencies: 1
Next IS-IS LAN Level-2 Hello in 7 seconds

FGT3 # get router info isis neighbor
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Result:

System Id Interface SNPA State Holdtime Type Protocol

1221.6818.2110 wan1 0009.0f85.ad8c Up 8 L2 IS-IS

1721.0160.1004 dmz1 0009.0f52.7704 Up 8 L2 IS-IS

Verification on FGT4 that the remote subnets from RTR1 and RTR2 are in the routing table and learned
with IS-IS

FGT4 # get router info routing-table all

Result:

Codes: K - kernel, C - connected, S - static, R - RIP, B - BGP
O - OSPF, IA - OSPF inter area

N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2
E1 - OSPF external type 1, E2 - OSPF external type 2
i - IS-IS, L1 - IS-IS level-1, L2 - IS-IS level-2, ia - IS-IS inter area
* - candidate default

i L2 10.1.1.0/24 [115/30] via 10.50.50.1, wan1, 00:12:46
i L2 10.2.2.0/24 [115/30] via 10.50.50.1, wan1, 00:12:46
i L2 10.3.3.0/24 [115/30] via 10.50.50.1, wan1, 00:12:46
i L2 10.4.4.0/24 [115/30] via 10.50.50.1, wan1, 00:12:46

i L2 10.10.10.0/24 [115/30] via 10.50.50.1, wan1, 00:12:46
i L2 10.11.11.0/24 [115/30] via 10.50.50.1, wan1, 00:12:46
i L2 10.20.20.0/24 [115/30] via 10.50.50.1, wan1, 00:12:46
i L2 10.30.30.0/24 [115/30] via 10.50.50.1, wan1, 00:13:55
i L2 10.40.40.0/24 [115/20] via 10.50.50.1, wan1, 00:15:30

C 10.50.50.0/24 is directly connected, wan1
C 10.60.60.1/32 is directly connected, loopback

Troubleshooting
The following diagnose commands are available for further IS-IS troubleshooting and will display all IS-IS activity
(sent and received packets):

FGT # diagnose ip router isis level info
FGT # diagnose ip router isis all enable
FGT # diagnose debug enable

...to stop the debug type output:

FGT # diagnose ip router isis level none
Output and interpretation depends on the issue faced. You can provide this information to TAC if you open a
support ticket.

2652 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Multicast forwarding

Multicast forwarding

Multicasting (also called IPmulticasting) consists of using a single multicast source to send data to many
receivers. Multicasting can be used to send data to many receivers simultaneously while conserving bandwidth
and reducing network traffic. Multicasting can be used for one-way delivery of media streams to multiple receivers
and for one-way data transmission for news feeds, financial information, and so on.

Also, RIPv2 uses multicasting to share routing table information, OSPF uses multicasting to send hello packets
and routing updates, Enhanced Interior Gateway Routing Protocol (EIGRP) uses multicasting to send routing
information to all EIGRP routers on a network segment and the Bonjour network service uses multicasting for
DNS.

A FortiGate unit can operate as a Protocol Independent Multicast (PIM) version 2 router. FortiGate units support
PIM sparse mode (RFC 4601) and PIM dense mode (RFC 3973) and can service multicast servers or receivers on
the network segment to which a FortiGate unit interface is connected. Multicast routing is not supported in
transparent mode (TPmode).

To support PIM communications, the sending/receiving applications and all
connecting PIM routers in between must be enabled with PIM version 2. PIM can use
static routes, RIP, OSPF, or BGP to forward multicast packets to their destinations.
To enable source-to-destination packet delivery, either sparse mode or dense mode
must be enabled on the PIM-router interfaces. Sparse mode routers cannot send
multicast messages to dense mode routers. In addition, if a FortiGate unit is located
between a source and a PIM router, two PIM routers, or is connected directly to a
receiver, you must create a security policy manually to pass encapsulated (multicast)
packets or decapsulated data (IP traffic) between the source and destination.

A PIM domain is a logical area comprising a number of contiguous networks. The domain contains at least one
Boot Strap Router (BSR), and if sparse mode is enabled, a number of Rendezvous Points (RPs) and Designated
Routers (DRs). When PIM is enabled on a FortiGate unit, the FortiGate unit can perform any of these functions at
any time as configured.

Sparse mode
Initially, all candidate BSRs in a PIM domain exchange bootstrap messages to select one BSR to which each RP
sends the multicast address or addresses of the multicast group(s) that it can service. The selected BSR chooses
one RP per multicast group and makes this information available to all of the PIM routers in the domain through
bootstrap messages. PIM routers use the information to build packet distribution trees, which map each multicast
group to a specific RP. Packet distribution trees may also contain information about the sources and receivers
associated with particular multicast groups.

When a FortiGate unit interface is configured as a multicast interface, sparse mode is
enabled on it by default to ensure that distribution trees are not built unless at least
one downstream receiver requests multicast traffic from a specific source. If the
sources of multicast traffic and their receivers are close to each other and the PIM
domain contains a dense population of active receivers, you may choose to enable
dense mode throughout the PIM domain instead.
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An RP represents the root of a non-source-specific distribution tree to a multicast group. By joining and pruning
the information contained in distribution trees, a single stream of multicast packets (for example, a video feed)
originating from the source can be forwarded to a certain RP to reach a multicast destination.

Each PIM router maintains a Multicast Routing Information Base (MRIB) that determines to which neighboring
PIM router join and prune messages are sent. An MRIB contains reverse-path information that reveals the path of
a multicast packet from its source to the PIM router that maintains the MRIB.

To send multicast traffic, a server application sends IP traffic to a multicast group address. The locally elected DR
registers the sender with the RP that is associated with the target multicast group. The RP uses its MRIB to
forward a single stream of IP packets from the source to the members of the multicast group. The IP packets are
replicated only when necessary to distribute the data to branches of the RP’s distribution tree.

To receive multicast traffic, a client application can use Internet Group Management Protocol (IGMP) version 1
(RFC 1112), 2 (RFC 2236), or 3 (RFC 3376) control messages to request the traffic for a particular multicast
group. The locally elected DR receives the request and adds the host to the multicast group that is associated
with the connected network segment by sending a join message towards the RP for the group. Afterward, the DR
queries the hosts on the connected network segment continually to determine whether the hosts are active.
When the DR no longer receives confirmation that at least one member of the multicast group is still active, the
DR sends a prune message towards the RP for the group.

FortiOS supports PIM sparse mode multicast routing for IPv6 multicast (multicast6) traffic and is compliant with
RFC 4601: Protocol Independent Multicast - Sparse Mode (PIM-SM). You can use the following CLI commands
to configure IPv6 PIM sparse multicast routing:

config router multicast6
set multicast-routing {enable | disable}

config interface
edit <interface-name>

set hello-interval <1-65535 seconds>
set hello-holdtime <1-65535 seconds>

end
config pim-sm-global

config rp-address
edit <index>

set ipv6-address <ipv6-address>
end

The following diagnose commands for IPv6 PIM sparse mode are also available:

diagnose ipv6 multicast status
diagnose ipv6 multicast vif
diagnose ipv6 multicast mroute

Dense mode
The packet organization used in sparse mode is also used in dense mode. When a multicast source begins to
send IP traffic and dense mode is enabled, the closest PIM router registers the IP traffic from the multicast source
(S) and forwards multicast packets to the multicast group address (G). All PIM routers initially broadcast the
multicast packets throughout the PIM domain to ensure that all receivers that have requested traffic for multicast
group address G can access the information, if needed.

To forward multicast packets to specific destinations afterward, the PIM routers build distribution trees based on
the information in multicast packets. Upstream PIM routers depend on prune/graft messages from downstream
PIM routers to determine if receivers are actually present on directly connected network segments. The PIM
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routers exchange state refresh messages to update their distribution trees. FortiGate units store this state
information in a Tree Information Base (TIB), which is used to build a multicast forwarding table. The information
in the multicast forwarding table determines whether packets are forwarded downstream. The forwarding table is
updated whenever the TIB is modified.

PIM routers receive data streams every few minutes and update their forwarding tables using the source (S) and
multicast group (G) information in the data stream. Superfluous multicast traffic is stopped by PIM routers that do
not have downstream receivers. PIM routers that do not manage multicast groups send prune messages to the
upstream PIM routers. When a receiver requests traffic for multicast address G, the closest PIM router sends a
graft message upstream to begin receiving multicast packets.

FortiGate units operating in NAT mode can also be configured as multicast routers. You can configure a
FortiGate unit to be a Protocol Independent Multicast (PIM) router operating in Sparse Mode (SM) or Dense
Mode (DM).

PIM support
A FortiGate unit can be configured to support PIM by going to Network > Multicast and enabling multicast
routing. You can also enable multicast routing using the config router multicast CLI command. When
PIM is enabled, the FortiGate unit allocates memory to manage mapping information. The FortiGate unit
communicates with neighboring PIM routers to acquire mapping information and if required, processes the
multicast traffic associated with specific multicast groups.

The end-user multicast client-server applications must be installed and configured to
initiate Internet connections and handle broadband content such as audio and video
information.

Client applications send multicast data by registering IP traffic with a PIM-enabled router. An end user can type in
a class D multicast group address, an alias for the multicast group address, or a conference call number to initiate
the session.

Rather than sending multiple copies of generated IP traffic to more than one specific IP destination address, PIM-
enabled routers encapsulate the data and use the one multicast group address to forward multicast packets to
multiple destinations. Because one destination address is used, a single stream of data can be sent. Client
applications receive multicast data by requesting that the traffic destined for a certain multicast group address be
delivered to them. End users may use phone books, a menu of ongoing or future sessions, or some other method
through a user interface to select the address of interest.

A class D address in the 224.0.0.0 to 239.255.255.255 range may be used as a multicast group address, subject
to the rules assigned by the Internet Assigned Numbers Authority (IANA). All class D addresses must be assigned
in advance. Because there is no way to determine in advance if a certain multicast group address is in use,
collisions may occur (to resolve this problem, end-users may switch to a different multicast address).

To configure a PIM domain

1. If you will be using sparse mode, determine appropriate paths for multicast packets.
2. Make a note of the interfaces that will be PIM-enabled. These interfaces may run a unicast routing protocol.
3. If you will be using sparse mode and want multicast packets to be handled by specific (static) RPs, record the IP

addresses of the PIM-enabled interfaces on those RPs.
4. Enable PIM version 2 on all participating routers between the source and receivers. On FortiGate units, use the

config router multicast command to set global operating parameters.
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5. Configure the PIM routers that have good connections throughout the PIM domain to be candidate BSRs.
6. If sparse mode is enabled, configure one or more of the PIM routers to be candidate RPs.
7. If required, adjust the default settings of PIM-enabled interface(s).

Multicast forwarding and FortiGate units
In both transparent mode and NAT mode, you can configure FortiGate units to forward multicast traffic.

For a FortiGate unit to forward multicast traffic, you must add FortiGate multicast security policies. Basic
multicast security policies accept any multicast packets at one FortiGate interface and forward the packets out
another FortiGate interface. You can also use multicast security policies to be selective about the multicast traffic
that is accepted, based on source and destination address, and to perform NAT on multicast packets.

In the example shown below, a multicast source on the marketing network with IP address 192.168.5.18 sends
multicast packets to the members of network 239.168.4.0. At the FortiGate unit, the source IP address for
multicast packets originating from workstation 192.168.5.18 is translated to 192.168.18.10. In this example, the
FortiGate unit is not acting as a multicast router.

Multicast forwarding and RIPv2

RIPv2 uses multicast to share routing table information. If your FortiGate unit is installed on a network that
includes RIPv2 routers, you must configure the FortiGate unit to forward multicast packets so that RIPv2 devices
can share routing data through the FortiGate unit. No special FortiGate configuration is required to share RIPv2
data, you can simply use the information in the following sections to configure the FortiGate unit to forward
multicast packets.

RIPv1 uses broadcasting to share routing table information. To allow RIPv1 packets
through a FortiGate unit, you can add standard security policies. Security policies to
accept RIPv1 packets can use the ALL predefined firewall service or the RIP
predefined firewall service.
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Example multicast network including a FortiGate unit that forwards multicast packets

Configuring FortiGate multicast forwarding
You configure FortiGate multicast forwarding from the CLI. Two steps are required:

1. Adding multicast security policies
2. Enabling multicast forwarding

This second step is only required if your FortiGate unit is operating in NAT mode. If your FortiGate unit is
operating in transparent mode, adding a multicast policy enables multicast forwarding.

There is sometimes confusion between the terms “forwarding” and “routing”. These
two functions should not be taking place at the same time.

It is mentioned that multicast-forward should be enabled when the FortiGate unit is in
NAT mode and that this will forward any multicast packet to all interfaces. However,
this parameter should NOT be enabled when the FortiGate unit operates as a
multicast router (for example, with a routing protocol enabled. It should only be
enabled when there is no routing protocols activated.

Adding multicast security policies

You need to add security policies to allow packets to pass from one interface to another. Multicast packets require
multicast security policies. You add multicast security policies from the CLI using the config firewall
multicast-policy command. As with unicast security policies, you specify the source and destination
interfaces and, optionally, the allowed address ranges for the source and destination addresses of the packets.

You can also use multicast security policies to configure source NAT and destination NAT for multicast packets.

Keep the following in mind when configuring multicast security policies:
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l The matched forwarded (outgoing) IP multicast source IP address is changed to the configured IP address.
l Source and destination interfaces are optional. If left blank, the multicast will be forwarded to ALL interfaces.
l Source and destination addresses are optional. If left unset, it means ALL addresses.
l The nat keyword is optional. Use it when source address translation is needed.

Enabling multicast forwarding

Multicast forwarding is enabled by default. In NAT mode you must use the multicast-forward keyword of
the system settings CLI command to enable or disable multicast forwarding. When multicast-
forward is enabled, the FortiGate unit forwards any multicast IP packets in which the TTL is 2 or higher to all
interfaces and VLAN interfaces except the receiving interface. The TTL in the IP header will be reduced by 1.
Even though the multicast packets are forwarded to all interfaces, you must add security policies to actually allow
multicast packets through the FortiGate. In our example, the security policy allows multicast packets received by
the internal interface to exit to the external interface.

Enabling multicast forwarding is only required if your FortiGate unit is operating in NAT
mode. If your FortiGate unit is operating in transparent mode, adding a multicast
policy enables multicast forwarding.

Enter the following CLI command to enable multicast forwarding:

config system settings
set multicast-forward enable

end

If multicast forwarding is disabled and the FortiGate unit drops packets that have multicast source or destination
addresses.

You can also use the multicast-ttl-notchange keyword of the system settings command so that
the FortiGate unit does not increase the TTL value for forwarded multicast packets. You should use this option
only if packets are expiring before reaching the multicast router.

config system settings
set multicast-ttl-notchange enable

end

In transparent mode, the FortiGate unit does not forward frames with multicast destination addresses. Multicast
traffic, such as the one used by routing protocols or streaming media, may need to traverse the FortiGate unit
and should not interfere with the communication. To avoid any issues during transmission, you can set up
multicast security policies. These types of security policies can only be enabled using the CLI.

The CLI parameter multicast-skip-policy must be disabled when using multicast
security policies. To disable enter the commands:

config system settings
     set multicast-skip-policy disable
end

In this simple example, no check is performed on the source or destination interfaces. Amulticast packet received
on an interface is flooded unconditionally to all interfaces on the forwarding domain, except the incoming
interface.
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To enable the multicast policy

config firewall multicast-policy
edit 1

set action accept
end

In this example, the multicast policy only applies to the source port of WAN1 and the destination port of Internal.

To enable the restrictive multicast policy

config firewall multicast-policy
edit 1

set srcintf wan1
set dstinf internal
set action accept

end

In this example, packets are allowed to flow from WAN1 to Internal, and sourced by the address 172.20.120.129,
which is represented by the address object "example_addr-1".

To enable the restrictive multicast policy

config firewall multicast-policy
edit 1

set srcintf wan1
set srcaddr example_addr-1
set dstinf internal
set action accept

end

This example shows how to configure the multicast security policy required for the configuration shown. This
policy accepts multicast packets that are sent from a PC with IP address 192.168.5.18 to destination address
range 239.168.4.0. The policy allows the multicast packets to enter the internal interface and then exit the
external interface. When the packets leave the external interface, their source address is translated to
192.168.18.10

config firewall multicast-policy
edit 5

set srcaddr 192.168.5.18 255.255.255.255
set srcintf internal
set destaddr 239.168.4.0 255.255.255.0
set dstintf external
set nat 192.168.18.10

end

This example shows how to configure a multicast security policy so that the FortiGate unit forwards multicast
packets from a multicast server with an IP 10.10.10.10 is broadcasting to address 225.1.1.1. This server is on the
network connected to the FortiGate DMZ interface.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2659



Multicast forwarding

config firewall multicast-policy
edit 1

set srcintf DMZ
set srcaddr 10.10.10.10 255.255.255.255
set dstintf Internal
set dstaddr 225.1.1.1 255.255.255.255
set action accept

edit 2
set action deny

end

Displaying IPv6 multicast router information

You can use the following CLI command to display IPv6 multicast router information (equivalent to the IPv4
version of the command):

get router info6 multicast

Multicast routing examples
This section contains the following multicast routing configuration examples and information:

l Example FortiGate PIM-SM configuration using a static RP
l FortiGate PIM-SM debugging examples
l Example multicast destination NAT (DNAT) configuration
l Example PIM configuration that uses BSR to find the RP

Example FortiGate PIM-SM configuration using a static RP

The example Protocol Independent Multicast Sparse Mode (PIM-SM) configuration shown below has been tested
for multicast interoperability using PIM-SM between Cisco 3750 switches running 12.2 and a FortiGate-800
running FortiOS v3.0 MR5 patch 1. In this configuration, the receiver receives the multicast stream when it joins
the group 233.254.200.1.
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Example: FortiGate PIM-SM topology

The configuration uses a statically configured rendezvous point (RP) which resides on the Cisco_3750_1. Using a
bootstrap router (BSR) was not tested in this example. See “Example PIM configuration that uses BSR to find the
RP” for an example that uses a BSR.

Configuration steps

The following procedures show how to configure the multicast configuration settings for the devices in the
example configuration.

l Cisco_3750_1 router configuration
l Cisco_3750_2 router configuration
l To configure the FortiGate-800 unit
l Cisco_3750_3 router configuration
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Cisco_3750_1 router configuration

version 12.2
!
hostname Cisco-3750-1
!
switch 1 provision ws-c3750-24ts
ip subnet-zero
ip routing
!
ip multicast-routing distributed
!
spanning-tree mode pvst
no spanning-tree optimize bpdu transmission
spanning-tree extend system-id
!
interface Loopback0

ip address 169.254.100.1 255.255.255.255
!
interface FastEthernet1/0/23

switchport access vlan 182
switchport mode access

!
interface FastEthernet1/0/24

switchport access vlan 172
switchport mode access

!
interface Vlan172

ip address 10.31.138.1 255.255.255.0
ip pim sparse-mode
ip igmp query-interval 125
ip mroute-cache distributed

!
interface Vlan182

ip address 169.254.82.250 255.255.255.0
ip pim sparse-mode
ip mroute-cache distributed

!
ip classless
ip route 0.0.0.0 0.0.0.0 169.254.82.1
ip http server
ip pim rp-address 169.254.100.1 Source-RP
!
ip access-list standard Source-RP

permit 233.254.200.0 0.0.0.255

Cisco_3750_2 router configuration

version 12.2
!
hostname Cisco-3750-2
!
switch 1 provision ws-c3750-24ts
ip subnet-zero
ip routing
!
ip multicast-routing distributed
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!
spanning-tree mode pvst
no spanning-tree optimize bpdu transmission
spanning-tree extend system-id
!
interface FastEthernet1/0/23

switchport access vlan 138
switchport mode access

!
interface FastEthernet1/0/24

switchport access vlan 182
witchport mode access

!
interface Vlan138

ip address 10.31.138.250 255.255.255.0
ip pim sparse-mode
ip mroute-cache distributed

!
interface Vlan182

ip address 169.254.82.1 255.255.255.0
ip pim sparse-mode
ip mroute-cache distributed

!
ip classless
ip route 0.0.0.0 0.0.0.0 10.31.138.253
ip route 169.254.100.1 255.255.255.255 169.254.82.250
ip http server
ip pim rp-address 169.254.100.1 Source-RP
!
!
ip access-list standard Source-RP
permit 233.254.200.0 0.0.0.255

To configure the FortiGate-800 unit

1. Configure the internal and external interfaces.
l Internal

Go to Network > Interfaces.

Select the internal interface.

Verify the following settings:

Type: Physical Interface

Addressing mode: Manual

IP/Network Mask: 10.31.138.253 255.255.255.0

Administrative Access: PING

Select OK.
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l External

Go to Network > Interfaces.
Select the external interface.

Verify the following settings:

Type: Physical Interface

Addressing mode: Manual

IP/Network Mask: 10.31.130.253 255.255.255.0

Administrative Access: HTTPS and PING

Select OK.

2. Add a firewall addresses.

Go to Policy & Objects > Addresses.

l RP

Select Create New.

Use the following settings:

Category Address

Name RP

Type Subnet

Subnet/IP Range 169.254.100.1/32

Interface Any

Visibility <enabled>

Select OK.

l Multicast source subnet

Select Create New.

Use the following settings:

Category Address

Name multicast_source_subnet
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Type Subnet

Subnet/IP Range 169.254.82.0/24

Interface Any

Visibility <enabled>

Select OK.

3. Add destination multicast address
Go to Policy & Objects > Addresses.

Select Create New.

Use the following settings:

Category Multicast Address

Name Multicast_stream

Type Broadcast Subnet

Broadcast Subnet 233.254.200.0/24

Interface Any

Visibility <enabled>

Select OK.

4. Add standard security policies to allow traffic to reach the RP.

Go to Policy & Objects > IPv4 Policy.
l 1st policy

Select Create New.

Use the following settings:

Incoming Interface internal

Source Address all

Outgoing Interface external

Destination Address RP

Schedule always
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Service ALL

Action ACCEPT

Select OK.

l 2nd policy

Select Create New

Use the following settings:

Incoming Interface external

Source Address RP

Outgoing Interface internal

Destination Address all

Schedule always

Service ALL

Action ACCEPT

Select OK.

5. Add the multicast security policy.

Go to Policy & Objects > Multicast Policy.

Select Create New.

Use the following settings:

Incoming Interface external

Source Address multicast_source_subnet

Outgoing Interface internal

Destination Address multicast_stream

Protocol Any

Action ACCEPT

Select OK.

6. Add an access list. (CLI only)
config router access-list
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edit Source-RP
config rule

edit 1
set prefix 233.254.200.0 255.255.255.0
set exact-match disable

next
end

7. Add some static routes.

Go to Network > Static Routes.
l Route 1

Select Create New.

Use the following settings:

Destination IP/Mask 0.0.0.0/0.0.0.0

Gateway 10.31.130.250

Interface internal

Administrative Distance <default>

Priority <default>

Select OK.

l Route 2

Select Create New.

Use the following settings:

Destination IP/Mask 169.254.0.0/16

Gateway 10.31.138.250

Interface external

Administrative Distance <default>

Priority <default>

Select OK.

8. Configure multicast routing.

Go to Network > Multicast.

Add the following Static Rendezvous Point(s):
      •   169.254.100.1

l Route 1
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Select Create New.

Use the following settings:

Interface internal

PIM Mode Sparse Mode

DR Priority <not needed in this scenario>

RP Candidate <not needed in this scenario>

RP Candidate Priority <not needed in this scenario>

Select OK.

l Route 2

Select Create New.

Use the following settings:

Interface external

PIM Mode Sparse Mode

DR Priority

RP Candidate

RP Candidate Priority

Select OK.

Cisco_3750_3 router configuration

version 12.2
!
hostname Cisco-3750-3
!
switch 1 provision ws-c3750-24ts
ip subnet-zero
ip routing
!
ip multicast-routing distributed
!
spanning-tree mode pvst
no spanning-tree optimize bpdu transmission
spanning-tree extend system-id
!
interface FastEthernet1/0/23

switchport access vlan 128
switchport mode access

!
interface FastEthernet1/0/24
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switchport access vlan 130
switchport mode access

!
interface Vlan128

ip address 10.31.128.130 255.255.255.252
ip pim sparse-mode
ip mroute-cache distributed

!
interface Vlan130

ip address 10.31.130.250 255.255.255.0
ip pim sparse-mode
ip mroute-cache distributed

!
ip classless
ip route 0.0.0.0 0.0.0.0 10.31.130.1
ip http server
ip pim rp-address 169.254.100.1 Source-RP
!
!
ip access-list standard Source-RP
permit 233.254.200.0 0.0.0.255

FortiGate PIM-SM debugging examples

Using the example topology shown below, you can trace the multicast streams and states within the three
FortiGate units (FGT-1, FGT-2, and FGT-3) using the debug commands described in this section. The command
output in this section is taken from the FortiGate unit when the multicast stream is flowing correctly from source
to receiver.

PIM-SM debugging topology

Checking that the receiver has joined the required group

From the last hop router, FGT-3, you can use the following command to check that the receiver has correctly
joined the required group.

FGT-3 # get router info multicast igmp groups
IGMP Connected Group Membership
Group Address Interface Uptime Expires Last Reporter
239.255.255.1 port3 00:31:15 00:04:02 10.167.0.62
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Only 1 receiver is displayed for a particular group, this is the device that responded to the IGMP query request
from the FGT-3. If a receiver is active, the expire time should drop to approximately 2 minutes before being
refreshed.

Checking the PIM-SM neighbors

Next, the PIM-SM neighbors should be checked. A PIM router becomes a neighbor when the PIM router receives
a PIM hello. Use the following command to display the PIM-SM neighbors of FGT-3:

FGT-3 # get router info multicast pim sparse-mode neighbour
Neighbor Interface Uptime/Expires Ver DR
Address Priority/Mode
10.132.0.156 port2 01:57:12/00:01:33 v2 1 /

Checking that the PIM router can reach the RP

The rendezvous point (RP) must be reachable for the PIM router (FGT-3) to be able to send the *,G join to
request the stream. This can be checked for FGT-3 using the following command:

FGT-3 # get router info multicast pim sparse-mode rp-mapping
PIM Group-to-RP Mappings
Group(s): 224.0.0.0/4, Static
RP: 192.168.1.1
Uptime: 07:23:00

Viewing the multicast routing table (FGT-3)

The FGT-3 unicast routing table can be used to determine the path taken to reach the RP at 192.168.1.1. You
can then check the stream state entries using the following commands:

FGT-3 # get router info multicast pim sparse-mode table
IP Multicast Routing Table

(*,*,RP) Entries: 0
(*,G) Entries: 1
(S,G) Entries: 1
(S,G,rpt) Entries: 1
FCR Entries: 0

(*,*,RP)
Entries

This state may be reached by general joins for all groups served by a specified RP.

(*,G) Entries State that maintains the RP tree for a given group.

(S,G) Entries State that maintains a source-specific tree for source S and group G.

(S,G,rpt)
Entries

State that maintains source-specific information about source s on the RP tree for G.
For example, if a source is being received on the source-specific tree, it will normally
have been pruned off the RP tree.

FCR The FCR state entries are for tracking the sources in the <*, G> when <S, G> is not
available for any reason, the stream would typically be flowing when this state exists.

Breaking down each entry in detail:
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(*, 239.255.255.1)
RP: 192.168.1.1
RPF nbr: 10.132.0.156
RPF idx: port2
Upstream State: JOINED
Local:
port3
Joined:
Asserted:
FCR:

The RPwill always be listed in a *,G entry, the RPF neighbor and interface index will also be shown. In this
topology these are the same in all downstream PIM routers. The state is active so the upstream state is joined.

In this case FGT-3 is the last hop router so the IGMP join is received locally on port3. There is no PIM outgoing
interface listed for this entry as it is used for the upstream PIM join.

(10.166.0.11, 239.255.255.1)
RPF nbr: 10.132.0.156
RPF idx: port2
SPT bit: 1
Upstream State: JOINED
Local:
Joined:
Asserted:
Outgoing:
port3

This is the entry for the SPT, no RP IS listed. The S,G stream will be forwarded out of the stated outgoing
interface.

(10.166.0.11, 239.255.255.1, rpt)
RP: 192.168.1.1
RPF nbr: 10.132.0.156
RPF idx: port2
Upstream State: NOT PRUNED
Local:
Pruned:
Outgoing:

The above S,G,RPT state is created for all streams that have both a S,G and a *,G entry on the router. This is
not pruned, in this case, because of the topology: the RP and source are reachable over the same interface.

Although not seen in this scenario, assert states may be seen when multiple PIM routers exist on the same LAN,
which can lead to more than one upstream router having a valid forwarding state. Assert messages are used to
elect a single forwarder from the upstream devices.

Viewing the PIM next-hop table

The PIM next-hop table is also very useful for checking the various states, it can be used to quickly identify the
states of multiple multicast streams.

FGT-3 # get router info multicast pim sparse-mode next-hop
Flags: N = New, R = RP, S = Source, U = Unreachable
Destination Type Nexthop Nexthop Nexthop Metric Pref Refcnt
Num Addr Ifindex
_______________________________________________________________
10.166.0.11 ..S. 1 10.132.0.156 9 21 110 3
192.168.1.1 .R.. 1 10.132.0.156 9 111 110 2
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Viewing the PIM multicast forwarding table

Also, you can check the multicast forwarding table showing the ingress and egress ports of the multicast stream.

FGT-3 # get router info multicast table

IP Multicast Routing Table
Flags: I - Immediate Stat, T - Timed Stat, F - Forwarder installed
Timers: Uptime/Stat Expiry
Interface State: Interface (TTL threshold)

(10.166.0.11, 239.255.255.1), uptime 04:02:55, stat expires 00:02:25
Owner PIM-SM, Flags: TF
Incoming interface: port2
Outgoing interface list:
port3 (TTL threshold 1)

Viewing the kernel forwarding table

Also, the kernel forwarding table can be verified, however this should give similar information to the above
command:

FGT-3 # diag ip multicast mroute
grp=239.255.255.1 src=10.166.0.11 intf=9 flags=(0x10000000)[  ] status=resolved
last_assert=2615136 bytes=1192116 pkt=14538 wrong_if=0 num_ifs=1
index(ttl)=[6(1),]

Viewing the multicast routing table (FGT-2)

If you check the output on FGT-2, there are some small differences:

FGT-2 # get router info multicast pim sparse-mode table
IP Multicast Routing Table

(*,*,RP) Entries: 0
(*,G) Entries: 1
(S,G) Entries: 1
(S,G,rpt) Entries: 1
FCR Entries: 0

(*, 239.255.255.1)
RP: 192.168.1.1
RPF nbr: 0.0.0.0
RPF idx: None
Upstream State: JOINED
Local:
Joined:
external
Asserted:
FCR:

The *,G entry now has a joined interface rather than local because it has received a PIM join from FGT-3 rather
than a local IGMP join.

(10.166.0.11, 239.255.255.1)
RPF nbr: 10.130.0.237
RPF idx: internal
SPT bit: 1
Upstream State: JOINED
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Local:
Joined:
external
Asserted:
Outgoing:
external

The S,G entry shows that we have received a join on the external interface and the stream is being forwarded out
of this interface.

(10.166.0.11, 239.255.255.1, rpt)
RP: 192.168.1.1
RPF nbr: 0.0.0.0
RPF idx: None
Upstream State: PRUNED
Local:
Pruned:
Outgoing:
External

The S,G,RPT is different from FGT-3 because FGT-2 is the RP, it has pruned back the SPT for the RP to the
first hop router.

Viewing the multicast routing table (FGT-1)

FGT-1 again has some differences with regard to the PIM-SM states. There is no *,G entry because it is not in
the path of a receiver and the RP.

FGT-1_master # get router info multicast pim sparse-mode table
IP Multicast Routing Table

(*,*,RP) Entries: 0
(*,G) Entries: 0
(S,G) Entries: 1
(S,G,rpt) Entries: 1
FCR Entries: 0

Below the S,G is the SPT termination because this FortiGate unit is the first hop router. The RPF neighbor
always shows as 0.0.0.0 because the source is local to this device. Both the joined and outgoing fields show as
external because the PIM join and the stream is egressing on this interface.

(10.166.0.11, 239.255.255.1)
RPF nbr: 0.0.0.0
RPF idx: None
SPT bit: 1
Upstream State: JOINED
Local:
Joined:
external
Asserted:
Outgoing:
external

The stream has been pruned back from the RP because the end-to-end SPT is flowing. In this case, there is no
requirement for the stream to be sent to the RP.

(10.166.0.11, 239.255.255.1, rpt)
RP: 0.0.0.0
RPF nbr: 10.130.0.156
RPF idx: external
Upstream State: RPT NOT JOINED
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Local:
Pruned:
Outgoing:

Example multicast DNAT configuration

The example topology shown and described below shows how to configure destination NAT (DNAT) for two
multicast streams. Both of these streams originate from the same source IP address, which is 10.166.0.11. The
example configuration keeps the streams separate by creating 2 multicast NAT policies.

In this example, the FortiGate units have the following roles:

l FGT-1 is the RP for dirty networks, 233.0.0.0/8.
l FGT-2 performs all firewall and DNAT translations.
l FGT-3 is the RP for the clean networks, 239.254.0.0/16.
l FGT-1 and FGT-3 are functioning as PM enabled routers and could be replaced can be any PIM enabled router.

This example only describes the configuration of FGT-2.

FGT-2 performs NAT so that the receivers connected to FGT-3 receive the following translated multicast
streams.

l If the multicast source sends multicast packets with a source and destination IP of 10.166.0.11 and 233.2.2.1,
FGT-3 translates the source and destination IPs to 192.168.20.1 and 239.254.1.1

l If the multicast source sends multicast packets with a source and destination IP of 10.166.0.11 and 233.3.3.1,
FGT-3 translates the source and destination IPs to 192.168.20.10 and 239.254.3.1

Example multicast DNAT topology

To configure FGT-2 for DNAT multicast

1. Add a loopback interface. In the example, the loopback interface is named loopback.
config system interface

edit loopback
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set vdom root
set ip 192.168.20.1 255.255.255.0
set type loopback

next
end

2. Add PIM and add a unicast routing protocol to the loopback interface as if it was a normal routed interface. Also,
add static joins to the loopback interface for any groups to be translated.

config router multicast
config interface

edit loopback
set pim-mode sparse-mode

config join-group
edit 233.2.2.1
next
edit 233.3.3.1
next

end
next

3. In this example, to add firewall multicast policies, different source IP addresses are required so you must first add
an IP pool:

config firewall ippool
edit Multicast_source

set endip 192.168.20.20
set interface port6
set startip 192.168.20.10

next
end

4. Add the translation security policies.

Policy 2, which is the source NAT policy, uses the actual IP address of port6. Policy 1, the DNAT policy, uses an
address from the IP pool. The source and destination addresses will need to be previously created address
objects. For this example, 233.3.3.1 255.255.255.255 will be represented by "example-addr_1" and 10.166.0.11
255.255.255.255 will be represented by "example-addr_2". You will likely want to use something more intuitive
from your own network.

config firewall multicast-policy
edit 1

set dnat 239.254.3.1
set dstaddr example-addr_1
set dstintf loopback
set nat 192.168.20.10
set srcaddr example-addr_2
set srcintf port6

next
edit 2

set dnat 239.254.1.1
set dstaddr 233.2.2.1 255.255.255.255
set dstintf loopback
set nat 192.168.20.1
set srcaddr 10.166.0.11 255.255.255.255
set srcintf port6

next
end

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2675



Multicast forwarding

5. Add a firewall multicast policy to forward the stream from the loopback interface to the physical outbound
interface.

This example is an any/any policy that makes sure traffic accepted by the other multicast policies can exit the
FortiGate unit.

config firewall multicast-policy
edit 3

set dstintf port7
set srcintf loopback

next
end

Example PIM configuration that uses BSR to find the RP

This example shows how to configure a multicast routing network for a network consisting of four FortiGate-500A
units (FortiGate-500A_1 to FortiGate-550A_4). A multicast sender is connected to FortiGate-500A_2. FortiGate-
500A_2 forwards multicast packets in two directions to reach Receiver 1 and Receiver 2.

The configuration uses a Boot Start Router (BSR) to find the Rendezvous Points (RPs) instead of using static
RPs. Under interface configuration, the loopback interface lo0 must join the 236.1.1.1 group (source).

This example describes:

l Commands used in this example
l Configuration steps
l Example debug commands

PIM network topology using BSR to find the RP

Commands used in this example

This example uses CLI commands for the following configuration settings:
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l Adding a loopback interface (lo0)
l Defining the multicast routing
l Adding the NAT multicast policy

Adding a loopback interface

Where required, the following command is used to define a loopback interface named lo0.

config system interface
edit lo0

set vdom root
set ip 1.4.50.4 255.255.255.255
set allowaccess ping https ssh snmp http telnet
set type loopback

next
end

Defining the multicast routing

In this example, the following command syntax is used to define multicast routing.

The example uses a Boot Start Router (BSR) to find the Rendezvous Points (RPs) instead of using static RPs.
Under interface configuration, the loopback interface lo0 must join the 236.1.1.1 group (source).

config router multicast
config interface

edit port6
set pim-mode sparse-mode

next
edit port1

set pim-mode sparse-mode
next
edit lo0

set pim-mode sparse-mode
set rp-candidate enable

config join-group
edit 236.1.1.1
next

end
set rp-candidate-priority 1

next
end

set multicast-routing enable
config pim-sm-global

set bsr-allow-quick-refresh enable
set bsr-candidate enable
set bsr-interface lo0
set bsr-priority 200

end
end

Adding the NAT multicast policy

In this example, the incoming multicast policy does the address translation.
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The NAT address should be the same as the IP address of the of loopback interface. The DNAT address is the
translated address, which should be a new group.

config firewall multicast-policy
edit 1

set dstintf port6
set srcintf lo0

next
edit 2

set dnat 238.1.1.1
set dstintf lo0
set nat 1.4.50.4
set srcintf port1

next

Configuration steps

In this sample, FortiGate-500A_1 is the RP for the group 228.1.1.1, 237.1.1.1, 238.1.1.1, and FortiGate-500A_4
is the RP for the other group which has a priority of1. OSPF is used in this example to distribute routes including
the loopback interface. All firewalls have full mesh security policies to allow any to any.

l In the FortiGate-500A_1 configuration, the NAT policy translates source address 236.1.1.1 to 237.1.1.1
l In the FortiGate-500A_4 configuration, the NAT policy translates source 236.1.1.1 to 238.1.1.1
l Source 236.1.1.1 is injected into network as well

The following procedures include the CLI commands for configuring each of the FortiGate units in the example
configuration.

To configure FortiGate-500A_1

1. Configure multicast routing:
config router multicast

config interface
edit port5

set pim-mode sparse-mode
next
edit port4

set pim-mode sparse-mode
next
edit lan

set pim-mode sparse-mode
next
edit port1

set pim-mode sparse-mode
next
edit lo999

set pim-mode sparse-mode
next
edit lo0

set pim-mode sparse-mode
set rp-candidate enable
set rp-candidate-group 1

next
end

set multicast-routing enable
config pim-sm-global
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set bsr-candidate enable
set bsr-interface lo0

end
end

2. Add multicast security policies:
config firewall multicast-policy

edit 1
set dstintf port5
set srcintf port4

next
edit 2

set dstintf port4
set srcintf port5

next
edit 3
next

end

3. Add router access lists:
config router access-list

edit 1
config rule

edit 1
set prefix 228.1.1.1 255.255.255.255
set exact-match enable

next
edit 2

set prefix 237.1.1.1 255.255.255.255
set exact-match enable

next
edit 3

set prefix 238.1.1.1 255.255.255.255
set exact-match enable

next
end

next
end

To configure FortiGate-500A_2

1. Configure multicast routing:
config router multicast

config interface
edit "lan"

set pim-mode sparse-mode
next
edit "port5"

set pim-mode sparse-mode
next
edit "port2"

set pim-mode sparse-mode
next
edit "port4"

set pim-mode sparse-mode
next
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edit "lo_5"
set pim-mode sparse-mode

config join-group
edit 236.1.1.1
next

end
next

end
set multicast-routing enable

end

2. Add multicast security policies:
config firewall multicast-policy

edit 1
set dstintf lan
set srcintf port5

next
edit 2

set dstintf port5
set srcintf lan

next
edit 4

set dstintf lan
set srcintf port2

next
edit 5

set dstintf port2
set srcintf lan

next
edit 7

set dstintf port1
set srcintf port2

next
edit 8

set dstintf port2
set srcintf port1

next
edit 9

set dstintf port5
set srcintf port2

next
edit 10

set dstintf port2
set srcintf port5

next
edit 11

set dnat 237.1.1.1
set dstintf lo_5
set nat 5.5.5.5
set srcintf port2

next
edit 12

set dstintf lan
set srcintf lo_5

next
edit 13

set dstintf port1
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set srcintf lo_5
next
edit 14

set dstintf port5
set srcintf lo_5

next
edit 15

set dstintf port2
set srcintf lo_5

next
edit 16
next

end

To configure FortiGate-500A_3

1. Configure multicast routing:
config router multicast

config interface
edit port5

set pim-mode sparse-mode
next
edit port6

set pim-mode sparse-mode
next
edit lo0

set pim-mode sparse-mode
set rp-candidate enable
set rp-candidate-priority 255

next
edit lan

set pim-mode sparse-mode
next

end
set multicast-routing enable

config pim-sm-global
set bsr-candidate enable
set bsr-interface lo0

end
end

2. Add multicast security policies:
config firewall multicast-policy

edit 1
set dstintf port5
set srcintf port6

next
edit 2

set dstintf port6
set srcintf port5

next
edit 3

set dstintf port6
set srcintf lan

next
edit 4

set dstintf lan
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set srcintf port6
next
edit 5

set dstintf port5
set srcintf lan

next
edit 6

set dstintf lan
set srcintf port5

next
end

To configure FortiGate-500A_4

1. Configure multicast routing:
config router multicast

config interface
edit port6

set pim-mode sparse-mode
next
edit lan

set pim-mode sparse-mode
next
edit port1

set pim-mode sparse-mode
next
edit lo0

set pim-mode sparse-mode
set rp-candidate enable

config join-group
edit 236.1.1.1
next

end
set rp-candidate-priority 1

next
end

set multicast-routing enable
config pim-sm-global

set bsr-allow-quick-refresh enable
set bsr-candidate enable
set bsr-interface lo0
set bsr-priority 1

end
end

2. Add multicast security policies:
config firewall policy

edit 1
set srcintf lan
set dstintf port6
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 2
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set srcintf port6
set dstintf lan
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 3

set srcintf port1
set dstintf port6
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 4

set srcintf port6
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 5

set srcintf port1
set dstintf lan
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 6

set srcintf lan
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 7

set srcintf port1
set dstintf port1
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 8

set srcintf port6
set dstintf lo0
set srcaddr all
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set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 9

set srcintf port1
set dstintf lo0
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
edit 10

set srcintf lan
set dstintf lo0
set srcaddr all
set dstaddr all
set action accept
set schedule always
set service ALL

next
end

Troubleshooting

Netflow support
Netflow is a networking feature, introduced by Cisco, to collect and export information about traffic flow through
routers. IPFIX (Internet Protocol Flow Information Export) is the standardized Internet Protocol based on NetFlow
version 9. The standards requirements for IPFIX are outlined in RFC 3197, and its basic specifications and other
information are documented in RFC 5103, RFC 6759, and RFC 7011 through RFC 7015.

You can enable and configure NetFlow traffic, using the following CLI commands:

config system netflow
set collector-ip <collector IP>
set collector-port <NetFlow collector port>
set csource-ip <Source IP for NetFlow agent>
set cactive-flow-timeout <time in minutes of timeout to report active flows>
set cinactive-flow-timeout <time in seconds of timeout for periodic report of finished

flows>
end

You can also configure these settings per VDOM, using the following CLI command:

config system vdom-netflow

You must also enable a Netflow sampler on specific interfaces.
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Using sFlow to monitor network traffic
FortiGate includes support for sFlow, a monitoring solution that uses packet sampling to monitor network traffic.
You can use sFlow to identify issues in your organization’s network that might impact performance. Because the
packet information that sFlow collects and sends is only a sampling of your network data, it has minimal impact
on the performance of your network.

The sFlow solution consists of the following components:

l sFlow Agent: Collects packet information, such as packet flow samples and interface counters
l sFlow Datagrams: Contains the packet information
l sFlow Collector: Analyzes the packet information and provides real-time reporting on your network traffic

The sFlow Agent is embedded in the FortiGate. After you configure sFlow on a FortiGate, the sFlow Agent
captures packet information, combines the information into sFlow Datagrams, and sends them to the sFlow
Collector. The sFlow Collector analyzes the sFlow Datagrams and presents the information so that you can see
the source of potential traffic issues. The FortiGate doesn’t act as an sFlow Collector. sFlow Collector software is
available from third-party software vendors.

The sFlow Agent performs packet sampling on packets that arrive on a FortiGate interface to determine which
ones to copy and send to the sFlow Collector. The packet information sFlow collects depends on the type of
FortiGate interface. If you enable sFlow on an internal interface, when the interface receives packets from
devices with private IP addresses, the packet information that sFlow collects includes the private IP addresses. If
you enable sFlow on an external (WAN) interface, when the interface receives packets to route to or from the
Internet, the packet information that sFlow collects includes the IP address of the WAN interface as the source or
destination interface, depending on the direction of the traffic. It doesn’t include IP addresses that are NAT’d
(Network Address Translation) on another interface.

sFlow Datagrams contain the following information:

l Packet headers, such as MAC, IPv4, and TCP
l Sample process parameters, such as rate and pool
l Input and output ports
l Priority (802.1p and ToS)
l VLAN (802.1Q)
l Source prefixes, destination prefixes, and next hop addresses
l BGP source AS, source peer AS, destination peer AS, communities, and local preference
l User IDs (TACACS, RADIUS) for source and destination
l URL associated with source and destination
l Interface statistics (RFC 1573, RFC 2233, and RFC 2358)

FortiOS implements sFlow version 5. For more information about sFlow, sFlow Collector software, and sFlow
MIBs, visit www.sflow.org.

Configuring sFlow on a FortiGate

You can configure sFlow globally, for VDOMs, or for interfaces on a FortiGate. When you configure sFlow for an
interface, you can configure the rate that the sFlow Agent samples traffic and the direction of that traffic. You can
also set the frequency that the sFlow Agent sends sFlow Datagrams to the sFlow Collector.

You configure sFlow in the FortiGate CLI, by performing the following tasks:
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1. Configure destination information for sFlow Datagrams. This also configures sFlow globally on the FortiGate.
2. Optionally, configure sFlow for one of the following:

l A virtual domain (VDOM)
l An interface

Prerequisites

l Install and configure an sFlow Collector

Configure destination information for sFlow Datagrams – CLI:

config system sflow
set collector-ip <ipv4_address>
set collector-port <port_number>
set source-ip <ipv4_address>

end

where you set the following variables:

CLI option Description

collector-ip The IPv4 address of the sFlow Collector

collector-port The UDP port number that the sFlow Agent on the FortiGate uses to send sFlow
Datagrams to the sFlow Collector. The default value is 6343.

Don’t change this setting unless the sFlow Collector or network configuration
requires you to change it.

source-ip The source IPv4 address that the FortiGate uses to send sFlow Datagrams to the
sFlow Collector

This setting is optional. If you don't configure a source IP address, the FortiGate
uses the source IP address of the port through which it sends the sFlow Datagram.

Configure sFlow for a VDOM – CLI:

When you configure sFlow for a VDOM, you specify the sFlow Collector that the VDOM will use. To have the
VDOM use the sFlow Collector that's configured globally on the FortiGate, don't enter values for the collector-ip
and collector-port options. To have the VDOM use a different sFlow collector, enter values for these options.

config system vdom-sflow
set vdom-sflow enable
set collector-ip <ipv4_address>
set collector-port <port_number>
set source-ip <ipv4_address>

end

where you set the following variables:

CLI option Description

collector-ip The IPv4 address of the sFlow Collector
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CLI option Description

collector-port The UDP port number that the sFlow Agent on the FortiGate uses to send sFlow
Datagrams to the sFlow Collector. The default value is 6343.

Don’t change this setting unless the sFlow Collector or network configuration
requires you to change it.

source-ip The source IPv4 address that the FortiGate uses to send sFlow Datagrams to the
sFlow Collector

This setting is optional. If you don't configure a source IP address, the FortiGate
uses the source IP address of the port through which it sends the sFlow Datagram.

Configure sFlow for an interface – CLI:

sFlow is supported on various FortiGate interfaces, including physical, VLAN, and aggregate interfaces.
However, sFlow isn’t supported on some virtual interfaces, such as VDOM link, IPsec, GRE, and SSL interfaces.

When you configure sFlow on an interface, you can set the rate that the sFlow Agent samples traffic on the
interface, the direction of that traffic, and the frequency that the sFlow Agent sends sFlow Datagrams to the
sFlow Collector.

If sFlow is configured for a VDOM that the interface belongs to, the sFlow Agent sends sFlow Datagrams to the
sFlow Collector that’s configured for the VDOM. Otherwise, the sFlow Datagrams are sent to the sFlow Collector
that’s configured globally on the FortiGate.

Configuring sFlow for an interface disables all NP4 and NP6 offloading for all traffic on that interface.

config system interface
edit <interface_name>

set sflow-sampler enable
set sample-rate <rate>
set sample-direction {tx | rx | both}
set polling-interval <interval>

next
end

where you set the following variables:

CLI option Description

sample-rate The average number of packets that the sFlow Agent lets pass before taking a
sample. The range is 10 to 99999. The default is 2000.

For example, if you set this to 1000, the sFlow Agent samples 1 out of every 1000
packets.

If you set a lower rate, the sFlow Agent samples a higher number of packets, which
increases the accuracy of the sampling data. However, this also increases the
amount of CPU resources and network bandwidth that sFlow uses.

In most cases, the default sample rate of 2000 provides enough accuracy.
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CLI option Description

sample-
direction

The direction of the traffic that the sFlow Agent samples:

l tx: Samples the traffic that the interface sends
l rx: Samples the traffic that the interface receives
l both: Samples the traffic that the interface sends and receives

polling-
interval

The amount of time, in seconds, that the sFlow Agent waits between sending
sFlow Datagrams to the sFlow Collector. The range is 1 to 255 seconds. The
default is 20 seconds.

If you set a higher polling interval, the sFlow Agent sends less data across your
network, but the sFlow Collector’s view of your network won’t be as up-to-date as it
would if you set a lower polling interval.

Packet capture
When troubleshooting networks, it helps to look inside the header of the packets. This helps to determine if the
packets, route, and destination are all what you expect. Packet capture can also be called a network tap, packet
sniffing, or logic analyzing.

To use the packet capture:

1. Go to Network > Packet Capture.
2. Select Create New or select an existing entry if you have already made one that fits your needs.
3. Select the interface to monitor and select the number of packets to keep.
4. Select Enable Filters.
5. Enter the information you want to gather from the packet capture.
6. Select OK.
To run the capture, select the play button in the progress column in the packet capture list. If not active, Not
Running will also appear in the column cell. The progress bar will indicate the status of the capture. You can
stop and restart it at any time.

When the capture is complete, select the Download icon to save the packet capture file to your hard disk for
further analysis.

Packet capture tells you what is happening on the network at a low level. This can be very useful for
troubleshooting problems, such as:

l Finding missing traffic
l Seeing if sessions are setting up properly
l Locating ARP problems such as broadcast storm sources and causes
l Confirming which address a computer is using on the network if they have multiple addresses or are on multiple

networks
l Confirming routing is working as you expect
l Wireless client connection problems
l Intermittent missing PING packets
l A particular type of packet is having problems, such as UDP, which is commonly used for streaming video
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If you are running a constant traffic application, such as ping, packet capture can tell you if the traffic is reaching
the destination, how the port enters and exits the FortiGate unit, if the ARP resolution is correct, and if the traffic
is returning to the source as expected. You can also use packet switching to verify that NAT, or other
configuration, is translating addresses or routing traffic the way that you want it to.

Before you start capturing packets, you need to have a good idea of what you are looking for. Capture is used to
confirm or deny your ideas about what is happening on the network. If you try capture without a plan to narrow
your search, you could end up with too much data to effectively analyze. On the other hand, you need to capture
enough packets to really understand all of the patterns and behavior that you are looking for.
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Parallel path processing - life of a packet

Directed by security policies, a FortiGate screens network traffic from the IP layer up through the application layer
of the TCP/IP stack. The steps involved in this inspection depend on the FortiGate hardware configuration (the
presence or absence of network processors such as the NP6 and content processors such as the CP8 and CP9)
and on the Unified Threat Management (UTM)/Next Generation Firewall (NGFW) inspection mode (flow-based
or proxy-based) of the FortiGate or VDOM.

This chapter describes what happens to a packet as it travels through a FortiGate running FortiOS 6.0.

The FortiGate performs three types of security inspection:

l Kernel-based stateful inspection, that provides individual packet-based security within a basic session state
l Flow-based inspection, that takes a snapshot of content packets and uses pattern matching to identify security

threats in the content
l Proxy-based inspection, that reconstructs content passing through the FortiGate and inspects the content for

security threats.

Each inspection component plays a role in the processing of a packet as it traverses the FortiGate en route to its
destination.
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Parallel Path Processing (PPP) uses the firewall policy configuration to choose from a group of parallel options to
determine the optimal path for processing a packet. Most FortiOS features are applied through Firewall policies
and the features applied determine the path a packet takes. Using firewall policies you can impose UTM/NGFW
processing on content traffic that may contain security threats (such as HTTP, email and so on). Many
UTM/NGFW processes are offloaded and accelerated by CP8 or CP9 processors. Using the policy configuration
you can apply a range of protection from basic IPS attack protection that looks for network-based attacks to full
scale advanced threat management (ATM), application control, antivirus, DLP and so on.

You can also create policies for traffic that does not pose security threats and bypass UTM/NGFW checking. This
control allows you to improve network performance without compromising security. On FortiGates with network
processors (for example the NP6) much of the traffic that does not require UTM/NGFW processing can be
offloaded to the NP6 processors freeing up FortiGate processing resources for other higher risk traffic.

In addition, many FortiGate models support NTurbo to offload flow-based UTM/NGFW sessions to network
processors. Flow-based sessions can also be accelerated using IPSA technology to enhance offloading of pattern
matching to CP8 and CP9 content processors.

This chapter begins with an overview of packet flow ingress and egress and includes a section that shows how
NP6 offloading optimizes packet flow for packets that don't require UTM/NGFW processing and for packets that
use NTurbo to offload flow-based UTM/NGFW processing.

Next this chapter breaks down how packets pass through UTM/NGFW processing both for a single-pass flow-
based UTM/NGFW processing and a proxy-based UTM/NGFW processing.
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High-level list of processes that affect packets
In general packets passing through a FortiGate can be affected by the following processes. This is a complete
high-level list of all of the processes. Not all packets see all of these processes. The processes a packet
encounters depends on the type of packet and on the FortiGate software and hardware configuration.

l Ingress packet flow
l Network Interface
l TCP/IP stack
l DoS Policy
l IP integrity header checking
l IPsec VPN decryption

l Admission Control
l Quarantine
l FortiTelemetry
l User Authentication

l Kernel
l Destination NAT
l Routing
l Stateful inspection/Policy

Lookup/Session management
l Session Helpers
l User Authentication
l Device Identification
l SSL VPN
l Local Management Traffic

l UTM/NGFW
l Flow-based inspection

l NTurbo
l IPSA

l Proxy-based inspection
l Explicit Web Proxy

l Kernel
l Forwarding
l Source NAT (SNAT)

l Egress packet flow
l IPsec VPN Encryption
l Botnet check
l Traffic shaping
l WANOptimization
l TCP/IP stack
l Network Interface
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This section describes the steps a packet goes through as it enters, passes through and exits from a FortiGate.
This scenario shows all of the steps a packet goes through if a FortiGate does not contain network processors
(such as the NP6).

Ingress
All packets accepted by a FortiGate pass through a network interface and are processed by the TCP/IP stack.
Then if DoS policies have been configured the packet must pass through these as well as automatic
IP integrity header checking.
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DoS scans are handled very early in the life of the packet to determine whether the traffic is valid or is part of a
DoS attack. The DoSmodule inspects all traffic flows but only tracks packets that can be used for DoS attacks (for
example, TCP SYN packets), to ensure they are within the permitted parameters. Suspected DoS attacks are
blocked, other packets are allowed.

IP integrity header checking reads the packet headers to verify if the packet is a valid TCP, UDP, ICMP, SCTP or
GRE packet. The only verification that is done at this step to ensure that the protocol header is the correct length.
If it is, the packet is allowed to carry on to the next step. If not, the packet is dropped.

Incoming IPsec packets that match configured IPsec tunnels on the FortiGate are decrypted after header
checking is done.

If the packet is an IPsec packet, the IPsec engine attempts to decrypt it. If the IPsec engine can apply the correct
encryption keys and decrypt the packet, the unencrypted packet is sent to the next step. Non-IPsec traffic and
IPsec traffic that cannot be decrypted passes on to the next step without being affected. IPsec VPN decryption is
offloaded to and accelerated by CP8 or CP9 processors.

Admission control
Admission control checks to make sure the packet is not from a source or headed to a destination on the
quarantine list. If configured admission control then imposes FortiTelemetry protection that requires a device to
have FortiClient installed before allowing packets from it. Admission control can also impose captive portal
authentication on ingress traffic.

Kernel
Once a packet makes it through all of the ingress steps, the FortiOS kernel performs the following checks to
determine what happens to the packet next.

Destination NAT

Destination NAT checks the NAT table and determines if the destination IP address for incoming traffic must be
changed using DNAT. DNAT is typically applied to traffic from the internet that is going to be directed to a server
on a network behind the FortiGate. DNAT means the actual address of the internal network is hidden from the
internet. This step determines whether a route to the destination address actually exists. DNAT must take place
before routing so that the FortiGate can route packets to the correct destination.

Routing (including SD-WAN)

Routing uses the routing table to determine the interface to be used by the packet as it leaves the FortiGate.
Routing also distinguishes between local traffic and forwarded traffic. Firewall policies are matched with packets
depending on the source and destination interface used by the packet. The source interface is known when the
packet is received and the destination interface is determined by routing.

SD-WAN is a special application of routing that provides route selection, load balancing, and failover among two
or more routes.

Stateful inspection/policy lookup/session management

Stateful inspection looks at the first packet of a session and looks in the policy table to make a security decision
about the entire session. Stateful inspection looks at packet TCP SYN and FIN flags to identity the start and end
of a session, the source/destination IP, source/destination port and protocol. Other checks are also performed on
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the packet payload and sequence numbers to verify it as a valid session and that the data is not corrupted or
poorly formed.

When the first packet of a session is matched in the policy table, stateful inspection adds information about the
session to its session table. So when subsequent packets are received for the same session, stateful inspection
can determine how to handle them by looking them up in the session table (which is more efficient than looking
them up in the policy table).

Stateful inspection makes the decision to drop or allow a session and apply security features to it based on what
is found in the first packet of the session. Then all subsequent packets in the same session are processed in the
same way.

When the final packet in the session is processed, the session is removed from the session table. Stateful
inspection also has a session idle timeout that removes sessions from the session table that have been idle for
the length of the timeout.

See the Stateful Firewall Wikipedia article (https://en.wikipedia.org/wiki/Stateful_firewall) for an excellent
description of stateful inspection.

Session helpers

Some protocols include information in the packet body (or payload) that must be analyzed to successfully process
sessions for this protocol. For example, the SIP VoIP protocol uses TCP control packets with a standard
destination port to set up SIP calls. To successfully process SIP VoIP calls, FortiOSmust be able to extract
information from the body of the SIP packet and use this information to allow the voice-carrying packets through
the firewall.

FortiOS uses session helpers to analyze the data in the packet bodies of some protocols and adjust the firewall to
allow those protocols to send packets through the firewall. FortiOS includes the following session helpers:

l PPTP
l H323
l RAS
l TNS
l TFTP
l RTSP
l FTP

l MMS
l PMAP
l SIP
l DNS-UDP
l RSH
l DCERPC
l MGCP

User authentication

User authentication added to security policies is handled by the stateful inspection, which is why Firewall
authentication is based on IP address. Authentication takes place after policy lookup selects a policy that includes
authentication.

Device identification

Device identification is applied if required by the matching policy.

SSL VPN

Local SSL VPN traffic is treated like special management traffic as determined by the SSL VPN destination port.
Packets are decrypted and are routed to an SSL VPN interface. Policy lookup is then used to control how packets
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are forwarded to their destination outside the FortiGate. SSL encryption and decryption is offloaded to and
accelerated by CP8 or CP9 processors.

Local management traffic

Local management traffic terminates at a FortiGate interface. This can be any FortiGate interface including
dedicated management interfaces. In multiple VDOM mode local management traffic terminates at the
management interface. In transparent mode, local management traffic terminates at the management IP
address.

Local management traffic includes administrative access, some routing protocol communication, central
management from FortiManager, communication with the FortiGuard network and so on. Management traffic is
allowed or blocked according to the Local In Policy list which lists all management protocols and their access
control settings. You configure local management access indirectly by configuring administrative access and so
on.

Management traffic is processed by applications such as the web server which displays the FortiOSGUI, the SSH
server for the CLI or the FortiGuard server to handle local FortiGuard database updates or FortiGuard Web
Filtering URL lookups.

Local management traffic is not involved in subsequent stateful inspection steps.

SSL VPN traffic terminates at a FortiGate interface similar to local management traffic. However, SSL VPN traffic
uses a different destination port number than administrative HTTPS traffic and can thus be detected and handled
differently.

UTM/NGFW
If the policy matching the packet includes security profiles, then the packet is subject to Unified Threat
Management (UTM)/Next Generation Firewall (NGFW) processing. UTM/NGFW processing depends on the
inspection mode of the FortiGate: Flow-based (single pass architecture) or proxy-based. Proxy-based processing
can include Explicit web proxy traffic. Many UTM/NGFW processes are offloaded and accelerated by CP8 or CP9
processors.

Single pass flow-based UTM/NGFW inspection identifies and blocks security threats in real time as they are
identified using single-pass Direct Filter Approach (DFA) pattern matching to identify possible attacks or threats.

Proxy-based UTM/NGFW inspection can apply both flow-based and proxy-based inspection. Packets initially
encounter the IPS engine, which can apply single-pass flow-based IPS and Application Control (as configured).
The packets are then sent to the proxy for proxy-based inspection. Proxy-based inspection can apply VoIP
inspection, DLP, AntiSpam, Web Filtering, Antivirus, and ICAP.

Explicit web proxy inspection is similar to proxy based inspection.

Content processors (CP8 and CP9)
Most FortiGate models contain Security Processing Unit (SPU) Content Processors (CPs) that accelerate many
common resource intensive security related processes. CPs work at the system level with tasks being offloaded to
them as determined by the main CPU. Capabilities of the CPs vary by model. Newer FortiGate units include CP8
and CP9 processors. Older CP versions still in use in currently operating FortiGate models include the CP4, CP5,
and CP6.
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CP9 capabilities

The CP9 content processor provides the following services:

l Flow-based inspection (IPS, application control etc.) pattern matching acceleration with over 10Gbps throughput
l IPS pre-scan
l IPS signature correlation
l Full match processors

l High performance VPN bulk data engine
l IPsec and SSL/TLS protocol processor
l DES/3DES/AES128/192/256 in accordance with FIPS46-3/FIPS81/FIPS197
l MD5/SHA-1/SHA256/384/512-96/128/192/256 with RFC1321 and FIPS180
l HMAC in accordance with RFC2104/2403/2404 and FIPS198
l ESNmode
l GCM support for NSA "Suite B" (RFC6379/RFC6460) including GCM-128/256; GMAC-128/256

l Key Exchange Processor that supports high performance IKE and RSA computation
l Public key exponentiation engine with hardware CRT support
l Primary checking for RSA key generation
l Handshake accelerator with automatic key material generation
l True Random Number generator
l Elliptic Curve support for NSA "Suite B"
l Sub public key engine (PKCE) to support up to 4096 bit operation directly (4k for DH and 8k for RSAwith CRT)

l DLP fingerprint support
l TTTD (Two-Thresholds-Two-Divisors) content chunking
l Two thresholds and two divisors are configurable

CP8 capabilities

The CP8 content processor provides the following services:

l Flow-based inspection (IPS, application control etc.) pattern matching acceleration
l High performance VPN bulk data engine

l IPsec and SSL/TLS protocol processor
l DES/3DES/AES in accordance with FIPS46-3/FIPS81/FIPS197
l ARC4 in compliance with RC4
l MD5/SHA-1/SHA256 with RFC1321 and FIPS180
l HMAC in accordance with RFC2104/2403/2404 and FIPS198

l Key Exchange Processor support high performance IKE and RSA computation
l Public key exponentiation engine with hardware CRT support
l Primarily checking for RSA key generation
l Handshake accelerator with automatic key material generation
l Random Number generator compliance with ANSI X9.31
l Sub public key engine (PKCE) to support up to 4096 bit operation directly

l Message authentication module offers high performance cryptographic engine for calculating SHA256/SHA1/MD5
of data up to 4G bytes (used by many applications)
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Packet flow ingress and egress: FortiGates without network processor
offloading

Chapter 22 - Parallel Path Processing - Life of a
Packet

l PCI express Gen 2 four lanes interface
l Cascade Interface for chip expansion

Kernel
Traffic is now in the process of exiting the FortiGate. The kernel uses the routing table to forward the packet out
the correct exit interface.

The kernel also checks the NAT table and determines if the source IP address for outgoing traffic must be
changed using SNAT. SNAT is typically applied to traffic from an internal network heading out to the internet.
SNAT means the actual address of the internal network is hidden from the internet.

Egress
Before exiting the FortiGate, outgoing packets that are entering an IPsec VPN tunnel are encrypted and
encapsulated. IPsec VPN encryption is offloaded to and accelerated by CP8 or CP9 processors. Packets are then
subject to botnet checking to make sure they are not destined for known botnet addresses.

Traffic shaping is then imposed, if configured, followed byWAN Optimization. The packet is then processed by
the TCP/IP stack and exits out the egress interface.
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Packet flow: NP6 and NP6lite sessions

On FortiGates with NP6 or NP6lite processors, the first packet of a session determines if the session can be
offloaded. As long as there is no proxy-based UTM/NGFW, if your FortiGate includes NP6 processors, most
sessions can be offloaded to them.
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Packet flow: NP6 and NP6lite sessions Chapter 22 - Parallel Path Processing - Life of a Packet

Access control list (ACL)

Access Control Lists (ACLs) use NP6 offloading to drop IPv4 or IPv6 packets at the physical network interface
before the packets are analyzed by the CPU. The ACL feature is available only on FortiGates with NP6-
accelerated interfaces. ACL checking is one of the first things that happens to the packet and checking is done by
the NP6 processor. The result is very efficient protection that does not use CPU or memory resources.
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Packet flow: NP6 and NP6lite offloaded session
After the first packet, subsequent packets in an offloaded session skip routing, UTM/NGFW, and kernel
processors and are just forwarded out the egress interface by the NP6 processor. As well, security measures such
as DoS policies, ACL, and so on are accelerated by the NP6 processor.
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Packet flow: NTurbo
If your FortiGate supports NTurbo, many flow-based UTM/NGFW sessions can be offloaded to NP6 processors.

After the first packet, subsequent packets in an offloaded flow-based UTM/NGFW session skip routing, and
kernel processors. Flow-based UTM/NGFW operations are still handled by the CPU with IPSA offloading pattern
matching to CP8 or CP9 processors.
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Packet flow: NP6 and NP6lite sessions Chapter 22 - Parallel Path Processing - Life of a Packet

If a security threat is found the session is dropped. Otherwise, packets that are not blocked by UTM/NGFW are
forwarded out of the egress interfaces by the NP6 processor.

NTurbo is not compatible with DoS policies, session helpers, or and most types of tunneling. If any of these
features are present, flow-based UTM/NGFW sessions are not offloaded by NTurbo.
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UTM/NGFW packet flow: flow-based inspection

Flow-based UTM/NGFW inspection identifies and blocks security threats in real time as they are identified using
single-pass architecture that involves Direct Filter Approach (DFA) pattern matching to identify possible attacks or
threats.

If a FortiGate or a VDOM is configured for flow-based inspection, depending on the options selected in the
firewall policy that accepted the session, flow-based inspection can apply IPS, Application Control,Web
Filtering, DLP, and AntiVirus. Flow-based inspection is all done by the IPS engine and as you would expect, no
proxying is involved.

Flow-based DLP is supported but not recommended. Flow-based DLP is not available
from the GUI, but can be configured from the CLI.

Before flow-based inspection can be applied the IPS engine uses a series of decoders to determine the
appropriate security modules to be applied depending on the protocol of the packet and on policy settings. In
addition, if SSL inspection is configured, the IPS engine also decrypts SSL packets. SSL decryption is offloaded
and accelerated by CP8 or CP9 processors.

If your configuration includes SSL mirroring, the IPS engine copies decrypted application content, wraps it inside
a TCP packet (with IP and ethernet headers), and sends it to the configured mirror interface. The TCP connection
tuple is carried over from the original SSL connection. For the Ethernet frame, destination address is broadcast
(FF:FF:FF:FF:FF:FF) and source address is all zeros.

All of the applicable flow-based security modules are applied simultaneously in one single pass, and pattern
matching is offloaded and accelerated by CP8 or CP9 processors. IPS, Application Control, flow-based Web
Filtering and flow-based DLP filtering happen together. Flow-based antivirus caches files during protocol
decoding and submits cached files for virus scanning while the other matching is carried out.

Flow-based inspection typically requires less processing resources than proxy-based inspection and since its not a
proxy, flow-based inspection does not change packets (unless a threat is found and packets are blocked). Flow-
based inspection cannot apply as many features as proxy inspection (for example, flow-based inspection does not
support client comforting and some aspects of replacement messages).

IPS and Application Control are only applied using flow-based inspection. Web Filtering, DLP and Antivirus can
also be applied using proxy-based inspection.
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UTM/NGFW packet flow: proxy-based inspection

If a FortiGate or VDOM is configured for proxy-based inspection then a mixture of flow-based and proxy-based
inspection occurs. Packets initially encounter the IPS engine, which uses the same steps described in
UTM/NGFW packet flow: flow-based inspection on page 2704 to apply single-pass IPS and Application Control if
configured in the firewall policy accepting the traffic.

The packets are then sent to the FortiOS UTM/NGFW proxy for proxy-based inspection. The proxy first
determines if the traffic is SSL traffic that should be decrypted for SSL inspection. SSL traffic to be inspected is
decrypted by the proxy. SSL decryption is offloaded to and accelerated by CP8 or CP9 processors.

If your configuration includes SSL mirroring, the IPS engine copies decrypted application content, wraps it inside
a TCP packet (with IP and ethernet headers), and sends it to the configured mirror interface. The TCP connection
tuple is carried over from the original SSL connection. For the Ethernet frame, destination address is broadcast
(FF:FF:FF:FF:FF:FF) and source address is all zeros.

Proxy-based inspection extracts and caches content, such as files and web pages, from content sessions and
inspects the cached content for threats. Content inspection happens in the following order: VoIP inspection,
DLP, Ant-Spam,Web Filtering, AntiVirus, and ICAP.

If no threat is found the proxy relays the content to its destination. If a threat is found the proxy can block the
threat and replace it with a replacement message.

Decrypted SSL traffic is sent to the IPS engine (where IPS and Application Control can be applied) before re-
entering the proxy where actual proxy-based inspection is applied to the decrypted SSL traffic. Once decrypted
SSL traffic has been inspected it is re-encrypted and forwarded to its destination. SSL encryption is offloaded to
and accelerated by CP8 or CP9 processors. If a threat is found the proxy can block the threat and replace it with a
replacement message.

The proxy can also block VoIP traffic that contains threats. VoIP inspection can also look inside VoIP packets and
extract port and address information and open pinholes in the firewall to allow VoIP traffic through.

ICAP intercepts HTTP and HTTPS traffic and forwards it to an ICAP server. The FortiGate is the surrogate, or
“middle-man”, and carries the ICAP responses from the ICAP server to the ICAP client; the ICAP client then
responds back, and the FortiGate determines the action that should be taken with these ICAP responses and
requests.
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UTM/NGFW packet flow: explicit web proxy

If the explicit web proxy is enabled on a FortiGate or VDOM, a mixture of flow-based and proxy-based inspection
occurs. One or more interfaces configured to listen for web browser sessions on the configured explicit web proxy
port (by default 8080) accept all HTTP and HTTPS sessions on the explicit proxy port that match an explicit web
proxy policy.

Plain text explicit web proxy HTTP traffic passes in parallel to both the IPS engine and the explicit web proxy for
content scanning. The IPS engine applies IPS and application control content scanning. The explicit web proxy
applies DLP, web filtering, and AntiVirus content scanning.

If the IPS engine and the explicit proxy do not detect any security threats, FortiOS relays the content to a
destination interface. If the IPS engine or the explicit proxy detect a threat, FortiOS can block the threat and
replace it with a replacement message.

Encrypted explicit web proxy HTTPS traffic passes to the explicit web proxy for decryption. Decrypted traffic once
again passes in parallel to the IPS engine and the explicit web proxy for content scanning.

If the IPS engine and the explicit proxy do not detect any security threats, the explicit proxy re-encrypts the traffic
and FortiOS relays the content to its destination. If the IPS engine or the explicit proxy detect a threat, FortiOS
can block the threat and replace it with a replacement message. The explicit proxy offloads HTTPS decryption
and encryption to CP8 or CP9 processors.

FortiOS uses routing to route explicit web proxy sessions through the FortiGate to a destination interface. Before
a session leaves the exiting interface, the explicit web proxy changes the source addresses of the session packets
to the IP address of the exiting interface. A FortiGate operating in transparent mode changes the source address
to the transparent mode management IP address. You can also configure the explicit web proxy to keep the
original client IP address.
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Comparison of inspection types

The tables in this section show how different security functions map to different inspection types.

Mapping security functions to inspection types
The table below lists FortiOS security functions and shows whether they are applied by the kernel, flow-based
inspection or proxy-based inspection.

FortiOS security functions and inspection types

Security Function Kernel
(Stateful inspection) Flow-based inspection Proxy-based inspection

Firewall yes

IPsec VPN yes

Traffic Shaping yes

User Authentication yes

Management
Traffic

yes

SSL VPN yes

IPS yes

Antivirus yes yes

Application Control yes

Web filtering yes yes

DLP yes yes

Email Filtering yes

VoIP inspection yes

ICAP yes

More information about inspection methods
The three inspection methods each have their own strengths and weaknesses. The following table looks at all
three methods side-by-side.
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Inspection methods comparison

Feature Stateful Flow Proxy

Inspection unit per
session

first packet selected packets, single
pass architecture,
simultaneous application
of configured inspection
methods

complete content,
configured inspection
methods applied in order

Memory, CPU required low medium high

Level of threat protection good better best

Authentication yes

IPsec and SSL VPN yes

Antivirus protection yes yes

Web Filtering yes yes

Data Leak Protection
(DLP) yes yes

Application control yes

IPS yes

Delay in traffic minor no small

Reconstruct entire
content no yes
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Chapter 23 - Sandbox Inspection

Sandbox inspection

This guide explains how to set up sandbox inspection using FortiSandbox with a FortiGate. It contains the
following sections:

l What's New in FortiOS 5.6.1: Highlights new features added.
l An Overview of Sandbox Inspection: General information about how sandbox inspection works.
l Using FortiSandbox with a FortiGate: How to set up sandbox inspection on a FortiGate.
l Sandbox Integration: Integrating sandbox inspection with FortiGate, FortiSandbox, and FortiClient.
l Sandbox Inspection FAQ: Frequently asked questions to help troubleshoot sandbox inspection.

What's new in FortiOS 5.6

The following section describes new Sandbox Integration features added to FortiOS 5.6.1.

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

New file extension lists for determining which file types to send to FortiSandbox (379326)

This feature introduces two new file extension lists:

l File extensions to submit to FortiSandbox even though the AV engine says they are unsupported.
l File extensions to exclude from submitting to FortiSandbox even though the AV engine says they are supported.

These lists are configured on the FortiSandbox, not the FortiGate, and are dynamically loaded on the FortiGate
via quarantine.

These lists are only file extensions and not file types detected by the AV engine using
magic bytes. Pattern matching is done on the extension of the filename only.

Syntax

diag sys scanunit reload-fsa-ext

FortiSandbox integration with AntiVirus in quick mode (436380)

FortiSandbox options in an AntiVirus Security Profile in quick scanning mode can now be enabled with CLI
commands.
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CLI syntax

config antivirus profile
edit default

set ftgd-analytics disable/everything
set analytics-max-upload 10
set analytics-wl-filetype 0
set analytics-bl-filetype 0
set analytics-db enable/disable
set scan-mode quick

end
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An Overview of Sandbox Inspection

This section contains information about how Fortinet sandbox inspection works.

l What is Sandbox Inspection?
l FortiSandbox Appliance vs FortiSandbox Cloud
l Sending Files for Sandbox Inspection

What is Sandbox Inspection?

Sandbox inspection is a network process that allows files to be sent to a separate device, such as FortiSandbox,
to be inspected without risking network security. This allows the detection of threats which may bypass other
security measures, including zero-day threats.

You can configure your FortiGate device to send suspicious files to FortiSandbox for inspection and analysis. The
FortiGate queries scan results and retrieves scan details. The FortiGate can also download malware packages as
a complimentary AV signature database to block future appearances of the same malware and download URL
packages as complimentary web filtering black list.

When a FortiGate sends files for sandbox inspection, the FortiSandbox uses virtual machines (VMs) running
different operating systems to test the file and to determine if it is malicious. If the file exhibits risky behavior, or is
found to contain a virus, a new signature can be added to the FortiGuard AntiVirus signature database.

When a FortiGate learns from FortiSandbox that a terminal is infected, the administrator can push instruction for
self-quarantine on a registered FortiClient host.

FortiSandbox can process multiple files simultaneously since the FortiSandbox has a VM pool. The time to
process a file depends on hardware and the number of sandbox VMs used to scan the file. It can take 60 seconds
to five minutes to process a file.

FortiSandbox Appliance vs FortiSandbox Cloud
FortiSandbox is available as a physical or virtual appliance (FortiSandbox Appliance), or as a cloud advanced
threat protection service integrated with FortiGate (FortiSandbox Cloud).

To select the settings for Sandbox Inspection, such as the FortiSandbox type, server, and notifier email, go to
Security Fabric > Settings.

The table below highlights the supported features of both types of FortiSandbox:

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2714



An Overview of Sandbox Inspection

Feature FortiSandbox Appliance
(including VM) FortiSandbox Cloud

Sandbox inspection for FortiGate Yes (FortiOS 5.0.4+) Yes (FortiOS 5.2.3+)

Sandbox inspection for FortiMail Yes (FortiMail OS 5.1+) Yes (FortiMail OS 5.3+)

Sandbox inspection for FortiWeb Yes (FortiWeb OS 5.4+) Yes (FortiWeb OS 5.5.3+)

Sandbox inspection for FortiClient Yes (FortiClient 5.4+ for Windows
only) No

Sandbox inspection for network share Yes No

Sandbox inspection for ICAP client Yes No

Manual File upload for analysis Yes Yes

Sniffer mode Yes Yes

File Status Feedback and Report Yes Yes

Dynamic Threat Database updates for
FortiGate Yes (FortiOS 5.4+) Yes (FortiOS 5.4+)

Dynamic Threat Database updates for
FortiClient

Yes (FortiClient 5.4 for Windows
only)

Yes (FortiClient 5.6+ for Windows
only)

Note that FortiMail keeps its own Dynamic Threat Database. For more information, see the FortiSandbox
documentation.

Sending Files for Sandbox Inspection
Sending files to the FortiSandbox appliance or to FortiSandbox Cloud does not block files immediately. Instead,
the files assist in the discovery of new threats and the creation of new signatures to be added to the global
FortiGuard AntiVirus database. Files deemed malicious are also immediately added to a custom Malware
Package which is downloaded by the FortiGate every two minutes for live detection.

Enable Sandbox Inspection by going to Security Fabric > Settings. You can also configure the FortiSandbox
type, server, and notifier email.

To see options for sending files for sandbox inspection, go to Security Profiles > AntiVirus. There are two
options for sending files: None orAll Supported Files. If All Supported Files is selected, users can withhold
files from being submitted for inspection by type or name pattern.

To learn how to connect the FortiSandbox, go to "Using FortiSandbox with a FortiGate" on page 2716
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Using FortiSandbox with a FortiGate

This section contains information about how to use sandbox inspection with FortiSandbox and FortiGate. It
includes the following sections:

l Connecting a FortiGate to FortiSandbox
l FortiSandbox Console

Connecting a FortiGate to FortiSandbox
The procedures for connecting a FortiGate to FortiSandbox differ depending whether you are using FortiSandbox
Appliance or FortiSandbox Cloud.

If you are using FortiSandbox in a Fortinet Security Fabric, consult the Fortinet Cookbook site for the Fortinet
Security Fabric collection of recipes.

Once the FortiGate is connected to FortiSandbox, an AntiVirus profile can be configured to send suspicious files
for inspection. Sandbox integration can also be configured, for more information see "Sandbox Integration" on
page 2718.

Connecting to FortiSandbox Appliance

1. Connect the FortiSandbox Appliance to your FortiGate so that port 1 and port 3 on the FortiSandbox are on
different subnets.

FortiSandbox port 3 is used for outgoing communication triggered by the
execution of the files under analysis. While the FortiSandbox can accept
files through any port, it is recommended to connect port 3 to a dedicated
interface on your FortiGate to protect the rest of the network from threats
currently being investigated by the FortiSandbox. Note too that port 1 can be
used to accept files but is generally reserved for managing the
FortiSandbox.

2. FortiSandbox port 3 must be able to connect to the Internet. On the FortiGate, go to Policy & Objects > IPv4
Policy and create a policy allowing connections from the FortiSandbox to the Internet (using the isolated interface
on the FortiGate mentioned above). On FortiSandbox, network settings for port3 can be configured by going to
Scan Policy > General.

3. On the FortiSandbox, go to Network > System Routing and add static routes for port 1.
4. On the FortiSandbox, go to Dashboard and locate the System Information widget. Now that the FortiSandbox

has Internet access, it can activate its VM licenses. Wait until a green arrow shows up besideWindows VM
before continuing to the next step.

5. On the FortiGate, go to Security Fabric > Settings. Select Enable Sandbox Inspection and select
FortiSandbox Appliance. Set the IP Address and enter a Notifier Email. If you select Test Connectivity,
the Status shows asService is not configured because the FortiGate has not been authorized to connect to
the FortiSandbox.

6. On the FortiSandbox, go to Scan Input > Device. Edit the entry for the FortiGate. Under Permissions &
Policy > Authorized, select the checkbox and clickOK to authorize the FortiGate.
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Using FortiSandbox with a FortiGate

7. On the FortiGate, go to Security Fabric > Settings and select Test Connectivity for the FortiSandbox. The
Status now shows that Service is online.

Connecting to FortiSandbox Cloud

Before you can connect a FortiGate to FortiSandbox Cloud, you need an active FortiCloud account.

Once you have created a FortiCloud account, sandbox inspection should be enabled by default. To verify this, go
to Security Fabric > Settings, enable Sandbox Inspection, and set to FortiSandbox Cloud.

To see the results from FortiSandbox Cloud in the FortiGate logs, go to Log & Report > Log Settings and
enable Send Logs to FortiCloud and set GUI Preferences is to display logs from FortiCloud.

FortiSandbox Console
The FortiSandbox console is available at FortiView > FortiSandbox. The console displays all samples
submitted for inspection. Information on the console can be filtered by checksum, file name, result, source,
status, and user name.

If you right-click on an entry, you can choose to Drill Down to Details, Quarantine Source Address, or
Quarantine FortiClient Device.

Information about the FortiSandbox database and sandboxing statistics are available at Security Fabric >
Settings once sandbox inspection is enabled. The Advanced Threat Protection dashboard widget shows you
the number of files that your FortiGate unit has uploaded or submitted to FortiSandbox.
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Sandbox Integration

Sandbox integration adds another level to sandbox inspection, allowing you allows you to set up automatic
actions to protect your network from files FortiSandbox determines are malicious. These actions include:
receiving AntiVirus signature updates from FortiSandbox, adding the originating URL of any malicious file to a
blocked URL list, and extending sandbox scanning to FortiClient devices.

This section contains the following topics:

l Overview
l Example Configuration

Overview
FortiSandbox integration involves three different FortiGate security profiles: AntiVirus, Web Filtering, and
FortiClient Profiles.

A FortiGate can retrieve scan results and details from FortiSandbox, and also receive antivirus and web filtering
signatures to supplement the current signature database. When FortiGate learns from FortiSandbox that an
endpoint is infected, the administrator can push instruction for self-quarantine on a registered FortiClient host.

When integrated with a FortiGate unit, the following protocols are supported by FortiSandbox: HTTP, HTTPS,
FTP, FTPS, POP3, POP3S, IMAP, IMAPS, SMTPS, MAPI, MAPIS, SMB, and supported IM protocols.

AntiVirus

When FortiSandbox discovers a malicious file, it can create an AntiVirus signature for that file and add that
signature to both the local FortiGate malware database and the FortiGuard AntiVirus signature database.
Through FortiSandbox integration, this signature can be sent to a FortiGate to block the file from re-entering the
network and to prevent the future retransmission of that file to FortiSandbox.

Use of the FortiSandbox AntiVirus database is enabled in an AntiVirus profile, found at Security Profiles
> AntiVirus. It can also be configured using the following CLI commands:

config antivirus profile
edit <profile>

set analytics-db enable
end

Web Filtering

FortiSandbox integration can also be used to allow FortiSandbox to add a URL filter blocking the source of a
discovered malicious file to the FortiGate's blocked URL list.

Blocking malicious URLs discovered by FortiSandbox is enabled in a Web Filter profile, found at Security
Profiles > Web Filter. It can also be configured using the following CLI commands:

config webfilter profile
edit <profile>

config web
set blacklist enable

end

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2718
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FortiClient Profiles

Extended FortiSandbox scanning is currently only supported by FortiClient 5.4 for
Windows. It can also only be used with FortiSandbox Appliance.

When extended FortiSandbox scanning is enabled for FortiClient, files downloaded by FortiClient can be sent to
the FortiSandbox for inspection. Also, if a suspicious file is discovered, FortiClient can be configured to wait until
sandbox inspection is complete before allowing that file to be accessed.

AntiVirus signatures can also be pushed by the FortiGate to FortiClient.

If a FortiClient device attempts to download a file that FortiSandbox discovers is malicious, the FortiSandbox
notifies the FortiGate. The administrator can take action to quarantine the device. When a quarantine is in effect,
FortiClient cuts off other network traffic from the device directly, preventing it from infecting or scanning the local
network. When a device is under quarantine, FortiClient cannot be shutdown or uninstalled. A user is also unable
to unregister from the FortiGate that quarantined them, or register to another FortiGate unit. A quarantine can
only be lifted by the administrator of the FortiGate where the FortiClient device is registered.

Extending FortiSandbox scanning can by configured in the Security settings of a FortiClient Profile, found at
Security Profiles > FortiClient Profiles. It can also be configured using the following CLI commands:

config endpoint-control profile
edit <profile>

config forticlient-winmac-settings
set forticlient-av enable
set av-realtime-protection enable
set sandbox-analysis enable
set sandbox-address <address>

end

Extending FortiSandbox scanning can also be configured directly in the FortiClient AntiVirus settings. If you are
using FortiClient version 5.6+, the Sandbox Detection feature can be used to send files to FortiSandbox for
analysis without having to install the AntiVirus feature. See the FortiClient 5.6 Administration Guide for details.

The number of files sent from a single device to FortiSandbox can be limited by configuring the submission limit
on the FortiSandbox. This allows users to prioritize which devices get the greater share of FortiSandbox
resources.

Example Configuration
The following example configuration sets up FortiSandbox integration using AntiVirus, Web Filtering, and a
FortiClient profile. This configuration assumes that a connection has already been established between the
FortiSandbox Appliance and the FortiGate.
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Sandbox Integration

1. Go to Security Fabric > Settings and confirm that Sandbox Inspection is enabled and the FortiSandbox
Appliance is connected.

2. Go to Security Profiles > AntiVirus and edit the default profile. Under Inspection Options, select All
Supported Files to be sent for inspection and enable Use FortiSandbox Database. You have the option of
withholding files by name or pattern. Select Apply.

3. Go to Security Profiles > Web Filter and edit the default profile. Under Static URL Filter, enable Block
malicious URLS discovered by FortiSandbox. Select Apply.

4. Go to Security Profiles > FortiClient Profiles and edit the default profile. Under Security Posture Check, enable
Realtime Protection. Next, enable Scan with FortiSandbox. Select Apply.

5. Go to Policy & Objects > IPv4 Policy and view the policy list. If a policy has AntiVirus and Web Filtering
profiles scanning applied, the profiles will be listed in the Security Profiles column. If scanning needs to be
added to any security policy (excluding the Implicit Deny policy) select the + button in the Security Profiles
column for that policy, then select the default AntiVirus Profile, the defaultWeb Filter Profile, the appropriate
Proxy Options, and select the deep-inspection profile for SSL/SSH Inspection (to ensure that encrypted
traffic is inspected).

6. Select OK.

Results

If your FortiGate discovers a suspicious file, it will be sent to the FortiSandbox. To view information about the
files that have been sent on the FortiGate, go to FortiView > FortiSandbox to see a list of file names and
current status.

To view results on the FortiSandbox, go to the Dashboardand view the Scanning Statisticswidget. There may
be a delay before results appear on the FortiSandbox.
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Open FortiClient using a Windows PC on the internal network. Make sure it is registered to your FortiGate. Go to
the AntiVirus tab and open Settings. You will see that the Realtime Protection settings match the FortiClient
profile configured on the FortiGate. These settings cannot be changed using FortiClient.

If a PC running FortiClient downloads a suspicious file that the FortiSandbox determined was malicious, a
quarantine would be applied automatically. While the quarantine is in effect, FortiClient cannot be shutdown on
the PC. It can not be uninstalled or unregistered from the FortiGate. The quarantine can only be released from
the FortiClient Monitor on the FortiGate.
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The following are some frequently asked questions about using sandbox inspection with FortiSandbox and
FortiGate.

Why is the FortiSandbox Cloud option not available when sandbox inspection is enabled?

This option is only available if you have already created a FortiCloud account.

Why don't results from FortiSandbox Cloud appear in the FortiGate GUI?

Go to Log & Report > Log Settings and make sure Send Logs to FortiCloud is enabled and
GUI Preferences is set to Display Logs from FortiCloud.

Why are the FortiSandbox Appliance VMs inactive?

Make sure that port 3 on the FortiSandbox has an active Internet connection. This is required in order
to active the FortiSandbox VMs.

Why aren't files are being scanned by FortiSandbox?

Make sure an AntiVirus profile that sends files to FortiSandbox is enabled for all policies that require
sandbox inspection.

Is FortiSandbox supported by FortiGate when in NAT or Transparent mode?

Yes, both NAT and Transparent mode are supported.

Are FortiGates behind a NAT device supported? If so how many?

Yes, multiple FortiGates can be supported in-line with FortiSandbox. Currently, there is a limitation
where the FortiSandbox will see all FortiGates only as one device so there is no way to differentiate
reports but all material will be sent.

If the FortiGate has a dynamic IP, will the FortiSandbox automatically update the FortiGate?

Yes. Dynamic IPs™ are supported and the FortiGate will not have to be reconfigured on the
FortiSandbox each time.
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Chapter 24 - Fortinet Security Fabric

Fortinet Security Fabric

The Fortinet Security Fabric is an end-to-end security solution that gives you control, integration, and easy
management of security across your entire organization. The Security Fabric provides an intelligent architecture
that interconnects discrete security solutions into an integrated whole to detect, monitor, block, and remediate
attacks across the entire enterprise attack surface.

This document is a complete reference guide for the Security Fabric, including an overview of what the Security
Fabric is, what devices are included in the Security Fabric and how they work together to secure your network,
and how to configure and manage the Security Fabric.
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What's new in the Security Fabric

This section contains a list of new features and enhancements for the Security Fabric.

FortiOS version 5.6.2
There are no new features for the Security Fabric in FortiOS version 5.6.2.

FortiOS version 5.6.1
FortiOS version 5.6.1 includes the following new features and enhancements for the Security Fabric.

FortiTelemetry support for IPsec VPN interfaces

You can now enable FortiTelemetry on IPsec VPN interfaces, and the Security Fabric can then detect the
downstream FortiGate through the IPsec VPN interface. This allows you to send FortiTelemetry communication
over a Gateway-to-Gateway IPsec VPN tunnel between two remote networks.

Redesigned Security Fabric menu

An updated GUI menu consolidates the Security Fabric features in one location. The new Security Fabric menu
includes options for Physical Topology, Logical Topology, Audit, and Settings.

Security Fabric settings page improvements

The Security Fabric settings page is updated to be a centralized location where you can enable connectivity to
other Fortinet products. The former Enable Security Fabric option is replaced by a FortiGate Telemetry
option, which is what you use to enable the Security Fabric. The formerDownstream FortiGates field is
replaced by a Topology field, which shows a hierarchical map view of the FortiGates that are connected to the
root FortiGate.

Security Fabric dashboard widget improvements

The Security Fabric dashboard widget is updated to include more Fortinet products. You can hover over the
FortiGate icon to see the overall status of FortiTelemetry, and hover over the other icons to see the status of
various devices in the Security Fabric.

The Security Fabric Score widget shows the Security Fabric Audit score and a list of the number of checks that
were not passed, ranked by severity (Critical, High, Medium, and Low). Clicking on the widget and selecting
View/apply recommendations in Security Fabric Audit, takes you to the Security Fabric Audit page.

Security Fabric topology page improvements

The Physical and Logical Topology pages include the following improvements:

l Updated Security Fabric legend
l New option to minimize the Topology: You can now show or hide areas of your organization’s topology using the

plus and minus signs beside the device icons in the topology pages. This makes it easier for you to view your
organization’s entire topology, or hide some areas of the topology to focus on other areas.
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l New resource information alerts: The Security Fabric topology now shows CPU Usage and Memory Usage alerts in
the device information tooltip. It also displays a warning if the FortiGate is in conserve mode.

SD-WAN support and improvements

The Security Fabric now supports SD-WAN by including SD-WAN information in the Security Fabric topology, and
adds SD-WANmonitoring support.

The Security Fabric topology now includes SD-WAN information. Enhancements include greater visibility into
where the data comes from and goes to, link saturation indicators, and detailed tooltip explanations.

The Security Fabric now retrieves monitoring information from all devices in the Security Fabric and displays it in
theMonitor pages, such as the Routing Monitor orQuarantine Monitor pages, in the root FortiGate GUI.
You can use the new drop-down menu in the monitor pages to select the device in the Security Fabric that you
would like to see monitoring information for.

FortiOS version 5.6
FortiOS version 5.6 includes the following new features and enhancements for the Security Fabric.

Security Fabric dashboard widgets

New dashboard widgets for the Security Fabric allow you to see information about the status of the Security
Fabric on the dashboard when you log in to the FortiGate.

Physical and Logical FortiView improvements

The FortiView Physical and Logical Topology pages include many improvements for the Security Fabric, such as
showing more devices, displaying link usage in different colors, ranking endpoints, and allowing you to search for
specific devices.

FortiClient Vulnerability Score

Endpoints in the Security Fabric topology are now ranked by their FortiClient Vulnerability Score. This score is
calculated by the severity of vulnerabilities found on the endpoint.

FortiView consolidation

Information about the Security Fabric can now be seen throughout the FortiView dashboard on the upstream
FortiGate when you use the real-time view.

Remote login to downstream FortiGates

You can now log in to downstream FortiGates from the upstream FortiGate, by right-clicking on the downstream
FortiGate when viewing the Security Fabric topology using FortiView.

Logging consolidation and improvements

The following changes have been made to improve logging for the Security Fabric:

l All FortiGates in the Security Fabric now send logs to a single FortiAnalyzer, by default. You configure the
connection to the FortiAnalyzer on the root FortiGate and the settings are then pushed to all other FortiGates in the
Security Fabric.
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l The following information about the Security Fabric configuration is now sent to the FortiAnalyzer: topology
information, interface roles, latitude and longitude information, and device asset tags.

l Monitors on the upstream FortiGate, such as the VPNMonitor, Route Monitor, and User Quarantine, can now view
the information from downstream devices.

l You can now see the log statistics for each FortiGate in the Security Fabric.

Device tree

The entire Security Fabric tree is now updated upward and each node has an updated state of the whole subtree.
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Security Fabric overview

The Fortinet Security Fabric provides a visionary approach to security that allows your organization to deliver
intelligent, powerful, and seamless security. Fortinet offers security solutions for endpoints, access points,
network elements, the data center, applications, cloud, and data, designed to work together as an integrated
security fabric that can be integrated, analyzed, and managed to provide end-to-end protection for your network.
Your organization can also add third-party products that are members of Fortinet’s Fabric-Ready Partner Program
to the Security Fabric.

All elements in the Security Fabric work together as a team to share policy, threat intelligence, and application
flow information. This collaborative approach expands network visibility and provides fast threat detection in real
time and the ability to initiate and synchronize a coordinated response, no matter which part of the network is
being compromised. The Security Fabric allows your network to automatically see and dynamically isolate
affected devices, partition network segments, update rules, push out new policies, and remove malware.

The Security Fabric is designed to cover the entire attack surface and provide you with complete visibility into your
network. It allows you to collect, share, and correlate threat intelligence between security and network devices,
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centrally manage and orchestrate policies, automatically synchronize resources to enforce policies, and
coordinate a response to threats detected anywhere across the extended network. The unified management
interface provides you with cooperative security alerts, recommendations, audit reports, and full policy control
across the Security Fabric that will give you confidence that your network is secure.

Access security
The Security Fabric secures the access layer of your organization’s network. It integrates various access points in
a network, such as endpoints, applications, the cloud, and IoT devices, regardless of their distribution, into an
end-to-end solution that covers all attack surfaces.

Secure access architecture extends coordinated security policies to the edge of the wired and wireless network,
where most vulnerabilities are targeted. It protects the access layer, guarding against data breaches and
cybersecurity threats from both internal user devices and IoT products.

Client security
Fortinet’s client security, through FortiClient, provides easy-to-manage, automated, fully customizable endpoint
security for various devices. FortiClient provides end-to-end threat visibility and control by natively integrating
endpoints into the security architecture and offers unified endpoint features, including compliance, protection,
and secure access. It also offers integrated patch management and vulnerability shielding to harden all
endpoints.

FortiClient integrates with the Security Fabric to provide real-time actionable visibility to stop threats to your
organization’s network at the endpoints.

For more information about FortiClient, see http://www.forticlient.com/.

Application security
The Security Fabric protects your organization’s sensitive and proprietary data that is managed by applications,
and ensures the security and availability of your organization’s applications. It allows Fortinet application security
products, and those of third-party vendors, to work together to boost security across core networks, remote
devices, and the cloud. This provides your organization with a network architecture that is secure, aware,
actionable, scalable, and open.

Fortinet‘s robust and integrated application security solution provides a complete end-to-end high-performance
solution that protects your organization’s valuable information by using a combination of Fortinet products which
are deeply integrated into the Security Fabric for direct communications. These products include web application
firewalls for application security, DDoS attack mitigation appliances for DDoS protection, advanced application
delivery controllers (ADCs) to meet the demands of secure application traffic, sandboxing to isolate malicious
code for inspection, and email security gateways that can detect and prevent email-borne threats from getting to
your users.
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Cloud security
The Security Fabric is designed to extend deep into different cloud environments to ensure that policies are
consistent and enforced across all distributed resources. Within the unified security architecture, virtual firewalls
can be deployed across private, public, and hybrid clouds to establish north-south and east-west
microsegmentation. The Security Fabric weaves cloud applications into the broader environment, governed by
seamless, universal security and compliance policies and managed using transparent visibility across the entire
attack surface. Combining Fortinet Cloud Security with an existing enterprise firewall deployment extends the
same powerful security, as well as the same intelligence and dynamic risk mitigation to applications located
either in the cloud or on-premise.

NOC and SOC security
Fortinet’s security operations center solution covers both IT and security risk management across your entire
organization. The solution is a comprehensive approach to managing risk that includes adaptive awareness of the
threat landscape, rapid local and global threat detection, reduced complexity in managing alerts and alarms, and
reporting and analytics so you can better understand how your organization’s risk profiles are being managed.

When Fortinet devices are unified into a Security Fabric, with compatible operating systems and shared
intelligence, the security operations solution also includes information from network elements beyond Fortinet
devices. The solution allows your network operations center (NOC) and security operations center (SOC) to share
information, integrating and cross-correlating the data from each operations center. This additional context,
visibility, and focus breaks down the barrier between your NOC and SOC, and gives you a comprehensive view
across your entire Security Fabric so you can quickly find and respond to threats.

Advanced threat intelligence
Fortinet’s Advanced Threat Protection (ATP) solution allows your organization to detect and mitigate against
threats, both known and unknown, and share that information locally to deliver a coordinated defence.

The ATP solution relies on many types of security technologies, products, and research applied from the network
edge through to endpoint devices. To deliver the most effective protection, they are integrated with other security
elements from the Enterprise Firewall and Cloud solutions to work together automatically, continuously handing
off data from one element to the next to identify, evaluate, and respond to attacks across the entire environment.

The ATP framework delivers end-to-end protection across the attack chain and consists of three elements:
prevention, detection, and mitigation, with continuous threat monitoring and analytics from FortiGuard Labs.

For more information about the Advanced Threat Protection Solution, see http://www.fortinet.com/atp.
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Partner API
The Fortinet Fabric-Ready Partner Program is an interoperability program for technology alliance partners.
Technology alliance partners integrate their products with the Fortinet Security Fabric using Fortinet Security
Fabric APIs. Their products are then able to actively collect and share threat and mitigation information from one
end of the security solution to the other, which improves threat intelligence, enhances overall threat awareness,
and broadens threat response.

Inclusion in the program means that Fabric-Ready Partners have collaborated with Fortinet and leveraged the
Fortinet Security Fabric APIs to develop and validate integrated end-to-end security solutions that are ready for
deployment.

The Fabric-Ready Partner Program allows Fortinet technology alliance partners to build on Fortinet products and
solutions which help your organization get even more value from your security deployment.

For more information about the Fortinet Fabric-Ready Partner Program, see
https://www.fortinet.com/content/dam/fortinet/assets/brochures/Fortinet-Fabric-Partner-Program.pdf.
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The Security Fabric solution components

The Fortinet Security Fabric consists of various components that work together to form the Security Fabric that
secures your organization’s network. The following diagram shows an example Security Fabric that contains both
required and recommended Fortinet products:

Devices in the Security Fabric
The Security Fabric implementation consists of required, recommended, and optional devices.
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Required devices

The following table shows devices that are required in the Fortinet Security Fabric:

Device Description

FortiGate FortiGate is a next-generation firewall (NGFW) that provides enterprise-class protection
against network, content, and application-level threats.

FortiGates are the core of the Security Fabric and can have one of the following roles in
the Security Fabric:

l Root FortiGate: The root FortiGate is the main component in the Security Fabric. It is
typically located on the edge of the network and connects the internal devices and
networks to the Internet through your ISP. From the root FortiGate, you can see
information about the entire Security Fabric from the Physical and Logical Topology
pages in the Security Fabric menu.

l Internal Segmentation Firewall (ISFW): After a root FortiGate is installed, all other
FortiGates in the Security Fabric act as ISFWs. An ISFW is a firewall that is located at
strategic points in your internal network, rather than on the network edge. This allows
extra security measures to be taken around key network components, such as servers
that contain valuable intellectual property. ISFW FortiGates create network visibility by
sending traffic and information about the devices that are connected to them to the root
FortiGate.

FortiAnalyzer FortiAnalyzer collects, analyzes, and correlates log data from Fortinet devices
throughout your organization’s network, and allows you to view all firewall traffic and
generate reports from a single console.

FortiAnalyzer gives you increased visibility into your organization’s network and
simplifies network logging by storing and displaying all log information in one place. It
provides centralized monitoring and awareness of threats, events, and network activity
by collecting and correlating logs from Security Fabric devices, such as FortiGate,
FortiClient, FortiSandbox, FortiWeb, and FortiMail. This gives you a deeper and more
comprehensive view across your entire Security Fabric. You can use the robust security
alert information and real-time threat intelligence that FortiAnalyzer provides to quickly
identify and respond to security threats across your organization’s network.

Recommended devices

The following table shows devices that Fortinet recommends you have in the Fortinet Security Fabric:

Device Description

FortiAP FortiAP is a wireless access point that provides integrated, secure, identity-driven
wireless LAN access for your organization’s network.

You can add FortiAPs to extend the Security Fabric to your wireless devices. Devices
connected to a FortiAP appear in the Physical and Logical Topology pages in the
Security Fabric menu.
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Device Description

FortiClient FortiClient adds endpoint control to devices that are located in the Security Fabric,
allowing only traffic from compliant devices to flow through the FortiGate. This is done
through FortiClient profiles.

In the Security Fabric, FortiClient profiles are applied by the first FortiGate that a
device’s traffic flows through. This is often an ISFW FortiGate. Device registration and
on-net status information for a device that is running FortiClient appears only on the
FortiGate that applies the FortiClient profile to the device.

FortiClient EMS FortiClient Enterprise Management Server (EMS) is a security management solution
that provides scalable and centralized management of multiple endpoint devices.

FortiClient EMS is used in the Security Fabric to provide visibility across your network,
to securely share information and assign security profiles to endpoints.

FortiMail FortiMail is a secure email gateway that uses various threat prevention methods,
including antispam, antimalware, sandboxing, and anomaly detection.

FortiMail integrates with other Fortinet products, as well as third-party virtual and cloud
platforms, to help establish a seamless Security Fabric across the entire attack
surface. FortiMail anti-spam processing helps offload other devices in the Security
Fabric that would typically carry out this process.

FortiManager FortiManager is an easy-to-use, single pane of glass management console, that gives
you total visibility, full control, and complete protection of your organization’s network.

Using the FortiManager in the Security Fabric allows you to simplify the network
management of devices in the Security Fabric by centralizing management access in a
single device. This allows you to easily control the deployment of security policies,
FortiGuard content security updates, firmware revisions, and individual configurations
for devices in the Security Fabric.

FortiSandbox FortiSandbox is an advanced threat protection appliance that improves your security
architecture by identifying and validating threats in a separate, secure environment.

You can add FortiSandbox to your Security Fabric to improve security with sandbox
inspection. Sandbox integration allows FortiGates in the Security Fabric to
automatically receive signature updates from FortiSandbox and add the originating
URL of any malicious file to a blocked URL list.
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Device Description

FortiSwitch FortiSwitch is a secure access switch that can be integrated into the Fortinet Security
Fabric through the FortiLink protocol. FortiLink allows FortiSwitch ports to become
logical extensions of the FortiGate. This allows the FortiGate to auto-discover a
connected FortiSwitch for provisioning, including the attachment of policy to ports or
VLANs. With an integrated access layer, the FortiGate provides consolidated visibility
and reporting with Physical and Logical Topology views of the Security Fabric in the
Security Fabric menu.

You can add a FortiSwitch to the Security Fabric when it is managed by a FortiGate
within the Security Fabric, and connected to an interface that uses FortiTelemetry.

Devices connected to the FortiSwitch appear in the Physical and Logical Topology
pages in the Security Fabric menu, and security features, such as FortiClient profiles,
are applied to them.

FortiWeb FortiWeb is a web application firewall that protects hosted web applications from
attacks that target known and unknown exploits.

In the Security Fabric, FortiWeb defends the application attack surface from attacks
that target application exploits. You can also configure FortiWeb to apply web
application firewall features, virus scanning, and web filtering to HTTP traffic to help
offload other devices in the Security Fabric that would typically carry out these
processes.

Optional devices

The following table shows devices that are optional in the Fortinet Security Fabric:

Device Description

Other Fortinet
products

Many other Fortinet products can be added to the Security Fabric, including
FortiAuthenticator, FortiToken, FortiCache, and FortiSIEM.

Third-party
products Third-party products that belong to the Fortinet Fabric-Ready Partner Program.

Security Fabric topology views
You can see the Security Fabric topology in the root FortiGate GUI. Two viewing options are available: the
Physical Topology view and the Logical Topology view.

The Physical Topology view displays the physical structure of your network, by showing the devices in the Security
Fabric and the connections between them. The Logical Topology view displays the logical structure of your
network, by connection, by showing information about logical and physical network interfaces in the Security
Fabric and the interfaces that connect devices in the Security Fabric. Only Fortinet devices are shown in the
topology views.

For more information about the topology views, see Viewing the Security Fabric topology.
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Security Fabric Audit
The Security Fabric Audit provides a method to continually monitor and improve your organization's Security
Fabric configuration. The Security Fabric Audit is a feature on the FortiGate that analyzes your Security Fabric
deployment, identifies potential vulnerabilities, and highlights best practices that you can use to improve the
overall security and performance of your network. Using the Security Fabric Audit helps you to:

l Tune your network configuration
l Deploy new hardware and software
l Have more visibility into your network
l Gain more control over your network
l Adhere to your organization's compliance requirements

The Security Fabric Audit provides a Security Fabric Score based on how many checks your network passes and
fails during the Security Fabric Audit. By checking the Security Fabric Score, and implementing the
recommendations, you can have confidence that your network is getting more secure over time.

For more information about running a Security Fabric Audit, see Running a Security Fabric Audit.

FortiTelemetry
FortiTelemetry is a protocol that Fortinet products in the Security Fabric use to communicate with each other. It
connects Security Fabric devices and allows dynamic status updates to travel between them. The Security Fabric
uses FortiTelemetry to link various security sensors and tools together to collect, coordinate, and respond to
malicious behavior anywhere it occurs in your network in real time.

You must enable FortiTelemetry on interfaces that connect Fortinet devices in the Security Fabric.
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Configuring the Security Fabric

To configure the Security Fabric, you must form the Security Fabric and then set up data collection for the
Security Fabric.

Setting up data collection includes configuring the FortiAnalyzer so that the entire Security Fabric is recognized by
the FortiAnalyzer. Once this is done, the root FortiGate and downstream FortiGates can show information about
all downstream FortiGates and other devices that are connected to them. Then you can use the Security Fabric
features to view, assess, and improve your organization’s network security.

System requirements
To set up the Security Fabric in FortiOS 5.6, the devices that you want to include in the Security Fabric must meet
the following requirements. Some features of the Security Fabric are available only in certain firmware versions.

Device Requirement Feature conditions

FortiGate l Version 5.6 and later
l All ISFW FortiGates should be running the same
firmware version as the root FortiGate

l FortiGate is a required device in the Security
Fabric

FortiAnalyzer

l Version 5.6 and later
l Logging to the FortiAnalyzer must be enabled
l FortiAnalyzer is a required device in the Security
Fabric

FortiClient Version 5.6 and later

FortiClient EMS Version 1.2 and later

FortiAP Version 5.4 and later Version 5.6 and later is
recommended to access all
features

FortiSwitch Version 3.5.2 and later
Version 3.5.3 and later is
recommended to access all
features

For more information about upgrading the Security Fabric to version 5.6, see the Security Fabric Upgrade guide.

Prerequisites
l Determine which devices you want to have in the Security Fabric
l Ensure devices meet the System requirements

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2736

https://docs.fortinet.com/document/fortigate/5.6.8/fortios-fortinet-security-fabric-upgrade-guide


Configuring the Security Fabric

l If devices are not already installed in your network, complete basic installation and configuration tasks by following
the instructions in the device documentation

l Disable virtual domains (VDOMs) on all FortiGates that you want to add to the Security Fabric
l Configure all FortiGate devices that you want to add to the Security Fabric to use NAT mode

Forming the Security Fabric
To form the Security Fabric, you configure the root FortiGate and then the ISFW FortiGates. Although you can
configure any of the FortiGates in the Security Fabric to be the root FortiGate, you typically configure the edge
FortiGate as the root FortiGate. This setup allows you to view the full topology of the Security Fabric from the top
down.

The following procedures include configuration steps for a typical Security Fabric implementation, where the root
FortiGate is the edge FortiGate and the ISFW FortiGates are all FortiGates that are downstream from the root
FortiGate.

Configure the root FortiGate for the Security Fabric

1. In the root FortiGate GUI, select Security Fabric >Settings.
2. In the Security Fabric Settings page, enable FortiGate Telemetry.
3. In theGroup name field, set a name for the Security Fabric group.
4. In theGroup password field, set a password for the Security Fabric group.
5. Ensure that Connect to upstream FortiGate is disabled.
6. In the FortiTelemetry enabled interfaces field, add the interfaces on this FortiGate that listen for downstream

Security Fabric connections.
The FortiAnalyzer Logging setting is automatically enabled.

7. In the IP address field, enter the IP address of the FortiAnalyzer that you want the Security Fabric to send logs to.
If you select Test Connectivity, and this is the first time that you are connecting the FortiGate to the
FortiAnalyzer, you will receive an error message because the FortiGate has not yet been authorized on the
FortiAnalyzer. You can configure this authorization when you configure the FortiAnalyzer.

8. In the Upload option field, select the option for how often you want the FortiGate to send logs to the
FortiAnalyzer.

9. If you want log transmissions encrypted, enable the Encrypt log transmission option. The log transmissions
are encrypted using SSL.

10. Select Apply.
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Configure ISFW FortiGates for the Security Fabric

1. In the ISFW FortiGate GUI, select Security Fabric >Settings.
2. In the Security Fabric Settings page, enable FortiGate Telemetry.
3. In theGroup name field, enter the group name that you set for the Security Fabric.
4. In theGroup password field, enter the group password that you set for the Security Fabric.
5. Enable the Connect to upstream FortiGate option.
6. In the FortiGate IP field, enter the IP address of the port on the upstream FortiGate that this FortiGate connects

to. Depending on your network topology, the upstream FortiGate is another ISFW FortiGate or the root FortiGate.
The FortiAnalyzer setting is automatically enabled. Settings for the FortiAnalyzer will be retrieved when the ISFW
FortiGate connects to the root FortiGate.

7. Select Apply.
8. Repeat this procedure on every ISFW in the Security Fabric.

Setting up data collection for the Security Fabric
To set up data collection for the Security Fabric, you enable device detection on ISFW FortiGates and then
connect the FortiAnalyzer to the Security Fabric.

You enable device detection on the interfaces of the ISFW FortiGates where you want the devices attached to
those interfaces added to the Security Fabric. Only devices detected on those interfaces are shown in the
Security Fabric topology views.

Connecting the FortiAnalyzer to the Security Fabric allows the Security Fabric to show historical data for the
Security Fabric topology and logs for the entire Security Fabric.

Enable device detection on ISFW FortiGates

1. In the ISFW FortiGate GUI, select Network > Interfaces.
2. Select the interface that you want to enable device detection on.
3. Select Edit.
4. In the Addressing mode field, select Manual.
5. In the IP/Network Mask field, enter a private IP address and network mask.
6. If you have FortiClient clients behind this interface, in the Administrative Access section, enable

FortiTelemetry.
7. If you require the FortiGate to provide IP addresses using DHCP to devices that connect to this interface, enable

DHCP Server. Suitable address ranges are automatically created.
8. In the Networked Devices section, enable Device Detection.
9. Select OK.
10. Repeat this procedure for every interface that you want to enable device detection on.
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Connect the FortiAnalyzer to the Security Fabric

Ensure that all FortiGates in the Security Fabric are registered with the
same FortiAnalyzer.

1. In the FortiAnalyzer GUI, select System Settings >Network.
2. Select All Interfaces.
3. Select the port that connects to the root FortiGate.
4. Select Edit.
5. In the IP Address/Netmask field, enter the IP address used for the Security Fabric configuration on the root

FortiGate.
6. In the Default Gateway field, enter the IP address of the interface on the root FortiGate that the FortiAnalyzer

connects to.
7. Select OK.
8. Select System Settings >Device Manager.

The FortiGates are listed asUnregistered.
9. Select the root FortiGate and the ISFW FortiGates in the Security Fabric.
10. Select + Add Device.

The FortiGates are now listed asRegistered.
A warning icon will appear beside the root FortiGate, because the FortiAnalyzer requires administrative access to
the root FortiGate in the Security Fabric.

11. In the Authentication window, complete the Admin User and Password fields to authenticate the Security
Fabric.
After the FortiAnalyzer authenticates the Security Fabric, the FortiAnalyzer shows the full Security Fabric
topology.

You can verify that the FortiAnalyzer configuration is successful by selecting Security Fabric >Settings on the
root and ISFW FortiGates. The Storage usage field in the FortiAnalyzer Logging section should now show
storage usage information.
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Using the Security Fabric to improve network security

Once you set up the Security Fabric, there are various Security Fabric features that you can use to improve your
network security, including the following:

l Dashboard widgets
l Topology views
l Security Fabric Audit
l Monitoring views

Understanding the Security Fabric dashboard widgets
You can add Security Fabric widgets to the dashboard on the root FortiGate. There are two widgets available: the
Security Fabric widget and the Security Fabric Score widget. The widgets allow you to see information about the
status of the Security Fabric when you first log in to the FortiGate.

If either of these widgets do not appear on your dashboard, you can add them using the settings button in the
bottom right corner. This button appears when your mouse hovers over any part of the dashboard.

On the root FortiGate, select Dashboard >Main.

The Security Fabric widget

The Security Fabric widget shows a visual summary of many of the devices in the Security Fabric. You can hover
over the icons at the top of the widget to get a quick view of the status of the Security Fabric, including the status
of FortiTelemetry and devices in the Security Fabric.

The widget shows the following information:

l The name of your Security Fabric
l Icons indicating the other Fortinet devices that can be used in the Security Fabric:

l Devices in blue are detected in your network
l Devices in gray are not detected in your network
l Devices in red are not detected in your network, but are recommended for the Security Fabric

l The names of the FortiGates in the Security Fabric
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The Security Fabric Score widget

The Security Fabric Score widget shows the latest Security Fabric Audit score and allows you to apply audit
recommendations from the dashboard.

The widget shows the following information:

l The time that the score was last calculated
l The Security Fabric score
l A list of the number of checks that were not passed, ranked by the following severities: Critical, High, Medium, and

Low

Viewing the Security Fabric topology
You can see the Security Fabric topology in the FortiGate GUI, in the Security Fabric menu. You can choose the
Physical Topology or Logical Topology views. In both topology views, you can hover over device icons and use
filtering and sorting options to see more information about devices and your organization's network. To view the
complete network, you must access the topology views on the root FortiGate in the Security Fabric.

You can also see the Security Fabric topology in the FortiAnalyzer GUI. In the FortiAnalyzer GUI, select Device
Manager. The FortiGates in the Security Fabric are shown as part of a Security Fabric group. An asterisk (*)
appears beside the root FortiGate in the Security Fabric. To see the topology of the Security Fabric, right-click on
the Security Fabric group and select Fabric Topology.

Only Fortinet devices are shown in the Security Fabric topology views.
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View the Physical Topology

The Physical Topology view shows the devices in the Security Fabric and the devices they are connected to. You
can also select whether or not to view access layer devices in this topology.

To see the Physical Topology, in the root FortiGate GUI, select Security Fabric >Physical Topology.

The Physical Topology view displays your network as a bubble chart of interconnected devices. These devices are
grouped based on the upstream device they are connected to. The bubbles appear smaller or larger, based on
their traffic volume. You can double-click any bubble to resize it and view more information about the device.

FortiGates and other networking devices are depicted as boxes. You can hover over the icon for each FortiGate to
see information, such as serial number, hostname, and firmware version. You can hover over the bubbles of other
devices to see information about them, such as name, IP address, and traffic volume data.

Security Fabric Audit recommendations are also shown in the topology, beside the icon of the device the
recommendations apply to.

View the Logical Topology

The Logical Topology view is similar to the Physical Topology view, but it shows the network interfaces, logical or
physical, that are used to connect devices in the Security Fabric.

To see the Logical Topology, in the root FortiGate GUI, select Security Fabric > Logical Topology.

The Logical Topology view displays your network as a bubble chart of network connection points. These devices
are grouped based on the upstream device interface they are connected to. The bubbles appear smaller or larger,
based on their traffic volume. You can double-click any bubble to re-size it.

FortiGates and other networking devices are depicted as boxes. You can hover over the icon for each FortiGate to
see information, such as serial number, hostname, and firmware version. You can also see each FortiGate
interface that has upstream and downstream devices connected to it. You can hover over the name of an
interface to see its IP address, network (subnet), and role.
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Security Fabric Audit recommendations are also shown in the topology, beside the icon of the device the
recommendations apply to.

Filter the topology views by specific criteria

You can use filters to narrow down the data on the topology views, so you can find specific information.

1. In the drop-down menu to the right of the Search field, select one of the following:
l Device Traffic
l Device Count
l Device Type
l Vulnerability
l Threat Score
l No Device

2. To filter the view by time, in the time period drop-down menu, select one of the following:
l now
l 5 minutes
l 1 hour
l 24 hours
l 7 days

3. To sort the topology by traffic options, in the Sort By drop-down menu, select one of the following:
l Bytes (Sent/Received)
l Packets (Sent/Received)
l Bandwidth
l Session

Running a Security Fabric Audit
You can run a Security Fabric Audit to analyze your organization's Security Fabric deployment, identify potential
vulnerabilities, and highlight best practices that you can use to improve the overall security and performance of
your organization's network.

The Security Fabric Audit performs a variety of checks when it analyzes your network. All checks are based on
your current network configuration, using real-time monitoring. The audit runs the checks across all FortiGates in
the Security Fabric.

When the audit is complete, a list of recommendations is shown. Two views are available: Failed or All Results.
You can filter these views further in order to view results from a specific FortiGate or all FortiGates. Each view has
a chart that shows the results of individual checks, and includes the name and a description of the check, which
FortiGate the check was performed on, the impact of the check on the overall security score, and
recommendations. If you hover over the result for a check, you can see a breakdown of how the score was
determined.

You can choose to automatically apply the recommendations that include the Easy Apply option. By using Easy
Apply, you can change the configuration of any FortiGate in the Security Fabric. Further action is required if you
want to follow other recommendations.

You can also view audit recommendations for specific devices in the Physical and Logical Topology views in the
Security Fabric menu. If a recommendation is available for a device, a circle containing a number appears. The

2743 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Using the Security Fabric to improve network security

number shows how many recommendations are available. The color of the circle shows the severity of the
highest check that failed. The following table shows the severity that each color represents:

Color Severity

Red Critical

Orange High

Yellow Medium

Blue Low

For more information about the Security Fabric Audit, and details about each of the audit checks that are
performed, see the Fortinet Recommended Security Best Practices document.

Run a Security Fabric Audit

You must run the Security Fabric Audit on the root FortiGate in the Security Fabric.

1. In the root FortiGate GUI, select Security Fabric >Audit.
In the Detect Security Fabric FortiGates step, all FortiGates in the Security Fabric are listed.

2. To run the audit, select Next.
The Audit will run. When it completes, the Audit step is displayed, which shows the following information:
l The Security Score field shows the score for your Security Fabric
l The page shows the overall count of how many checks passed or failed, with the failed checks divided by

severity
l Information about each failed check, including which FortiGate failed the check, the effect of the check failure

on the security score, and recommendations to fix the issue
l The Easy Apply option appears with recommendations that can be automatically applied by the wizard

3. To move to the Easy Apply option page, select Next.
4. Select all recommendations that you want to implement in the Security Fabric.
5. Select Apply Recommendations.

Set up logging for the Security Fabric Audit

You can configure an event filter subtype for the Security Fabric Audit. When you run an audit, event logs are
created on the root FortiGate that summarize the results of the audit and show detailed information for the
individual tests.

To configure logging for the Security Fabric Audit, use the following CLI commands:

config log eventfilter
set security-audit {enable | disable}

end

Understanding the Security Fabric Score

When you run a Security Fabric Audit, your organization's Security Fabric receives a Security Fabric Score. The
score will be positive or negative, and a higher score represents a more secure network.
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The score is based on how many checks your network passes and fails, as well as the severity level of these
checks. The following table shows the weight for each severity level:

Severity level Weight

Critical 50 points

High 25 points

Medium 10 points

Low 5 points

The audit awards points when a check passes, using the following formula:

+ <Severity Weight> x <Secure FortiGateMultiplier>

where:

l Severity Weight is <Severity level> / <number of FortiGates in the Security Fabric>
l Secure FortiGateMultiplier is determined using logarithms and the number of FortiGates in the Security Fabric

For example, if you have four FortiGates in the Security Fabric, and all of them pass the Compatible Firmware
check, the score for each FortiGate is calculated as: (50/4) x 1.292 = 16.2 points.

All FortiGates in the Security Fabric must pass the check in order to receive points. If any of the FortiGates in the
Security Fabric fail a check, any FortiGates in the Security Fabric that passed the check are not awarded points.
For the FortiGate that failed the test, the score is calculated using the following formula:

- <Severity Weight> x <Count>

where:

l Severity Weight is <Severity level>
l Count is the number of times the check failed during the audit

For example, if the audit finds two critical FortiClient vulnerabilities, the score for that check is calculated as: -50 x
2 = -100 points.

The score is not affected by checks that do not apply to your network. For example, if you do not have any
FortiAPs in the Security Fabric, you will not receive any points for the FortiAP Firmware Versions check.
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Viewing monitoring information for devices in the Security Fabric
The Security Fabric retrieves monitoring information from all devices in the Security Fabric and displays it in the
monitor pages in the root FortiGate GUI.

View monitoring information for a specific device in the Security Fabric

1. In the root FortiGate GUI, select Monitor.
2. Select the monitor page that you want to view. For example, Routing Monitor orQuarantine Monitor.
3. In the drop-down menu, select the device in the Security Fabric that you want to see monitoring information for.
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Related resources

Document Location

The Security Fabric Cookbook
Recipe Collection

http://cookbook.fortinet.com/security-fabric-56/

Security Fabric UpgradeGuide https://docs.fortinet.com/document/fortigate/5.6.8/fortios-fortinet-
security-fabric-upgrade-guide

Fortinet Communication Ports and
Protocols Guide

https://docs.fortinet.com/document/fortigate/5.6.0/fortinet-
communication-ports-and-protocols

FortiGate documentation https://docs.fortinet.com/product/fortigate/5.6

FortiAnalyzer documentation https://docs.fortinet.com/product/fortianalyzer/5.6

FortiClient documentation https://docs.fortinet.com/product/forticlient/5.6

FortiClient EMS documentation https://docs.fortinet.com/product/forticlient/5.6

FortiMail documentation https://docs.fortinet.com/product/fortimail/6.0

FortiManager documentation https://docs.fortinet.com/product/fortimanager/5.6

FortiSandbox documentation https://docs.fortinet.com/product/fortisandbox/3.0

FortiSwitch documentation https://docs.fortinet.com/product/fortiswitch/6.0

FortiWeb documentation https://docs.fortinet.com/product/fortiweb/6.0
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Chapter 25 - Security Profiles

Security profiles

Welcome and thank you for selecting Fortinet products for your network protection.

The following chapter describes the Security Profile features available on your FortiGate unit, including antivirus,
intrusion prevention system (IPS), web filtering, email filtering, data leak prevention, (DLP) and application
control. The guide includes step-by-step instructions showing how to configure each feature. Example scenarios
are included, with suggested configurations.

Examples include scenarios using web filtering to protect users from inappropriate content, using IPS to protect
web servers from attack, and using antivirus scanning to protect your network against viruses and malicious file
attachments.

Before you begin
Before you begin using this guide, take a moment to note the following:

Administrators are assumed to be super_admin administrators unless otherwise specified. Some restrictions will
apply to other administrators.

Firewall policies limit access, and, while this and other similar features are a vital part of securing your network,
they are not covered in this guide.

If your FortiGate unit supports SSL acceleration, it also supports SSL content scanning and inspection for
HTTPS, IMAPS, POP3S, and SMTPS traffic.

How this chapter is organized
This FortiOS Handbook chapter contains the following sections:

l What's New in FortiOS 5.6 describes the new security profile features in FortiOS 5.6.
l Inside FortiOS highlights the features and benefits of key FortiOS 5.6 components. The technical documentation

team maintains these documents as part of the Handbook and as standalone documents which are available at
Fortinet's Online Help. Inside FortiOS covers the following security profiles topics:
l AntiVirus
l Application Control
l Intrusion Prevention System
l Web Filtering

l Security Profiles overview describes Security Profiles components and their relation to firewall policies, as well as
SSL content scanning and inspection.

l Inspection Modes discusses the FortiGate's inspection modes and how the security profiles function depending on
inspection mode.

l AntiVirus explains how the FortiGate unit scans files for viruses and describes how to configure the antivirus
options.
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l Web filter describes basic web filtering concepts, FortiGuard Web Filtering, the order in which the FortiGate unit
performs web filtering, and configuration.

l DNS filter explains how to configure the Domain Name System (DNS) Filter security profile independent of the Web
Filter security profile.

l Application Control describes how your FortiGate unit can detect and take action against network traffic based on
the application generating the traffic.

l Intrusion prevention explains basic Intrusion Protection System (IPS) concepts and how to configure IPS options;
includes guidance and a detailed table for creating custom signatures as well as several examples.

l Anti-Spam filter explains how the FortiGate unit filters email, how to configure the filtering options, and which
actions to take when spam is detected.

l Data leak prevention describes the DLP features that allow you to prevent sensitive data from leaving your network
and explains how to configure the DLP rules, compound rules, and sensors.

l ICAP support describes how to offload traffic to a separate server specifically set up for the specialized processing
of the traffic.

l FortiClient Profiles addresses the FortiClient Profiles endpoint protection features and configuration.
l SSL/SSH Inspection presents SSl and SSH content scanning and inspection with your FortiGate.
l Custom Application & IPS Signatures describes how to create custom Application Control and IPS signatures.
l Other Security Profiles considerations addresses topics like Security Profiles VDOMs, conserve mode, using

wildcards and Perl regular expressions, adding External Security Devices, CPU allocation and tuning commands to
survive reboot and so on.
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This chapter describes new Security Profile features added to FortiOS 5.6.

FortiOS 5.6.4
These features first appeared in FortiOS 5.6.4.

l "Configuring the FortiClient offline grace period" on page 2921
l "Excluding industrial IP signatures" on page 2958

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Added multiple ports and port range support in the explicit ftp/web proxy (402775)

Added multiple ports and port range support in the explicit ftp/web proxy:

l added new monitor api endpoint for checking whether a list of TCP port ranges is being used, sample usage:
/api/v2/monitor/system/check-port-availability?port_ranges=[{"start":8080,"end":8080},{"start":400,"end":600},
{"start":1,"end":200}]&service=webproxy

l added GUI support for port ranges in web-proxy and ftp-proxy settings

Block access to unsupported FortiClient endpoints (457695)

You can use the following command to deny registration of unsupported FortiClients endpoints. An unsupported
FortiClient endpoint means the endpoint is running FortiClient but for some reason not all of the criteria are
available to identify the endpoint, or the endpoint may be running an unsupported version of FortiClient.
Information required that is not available could include the endpoint's IP address or MAC address is not visible.

config endpoint-control setting
set forticlient-dereg-unsupported-client {enable | disable}

end

Exempt list fix (381762)

The FortiClient Monitor page now shows exempt device types, as opposed to just the device category. FortiOS
can now differentiate the three cases both from backend and GUI.

Backend changes

Differentiate the three cases:

l exempt by custom device
l exempt by device category
l exempt by device group

GUI changes

1. Monitor > FortiClient Monitor page:
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l show device exempt reasons as any combination of device, device category, device group, source address.

2. Update REST monitor api
l (URI: /api/v2/monitor/user/device/select?compliance_visibility=true)
l update "exempt_reason" field from string to array of strings in json result

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.

FortiGuard WAN IP blacklist service is now online (404859)

The Fortiguard WAN IP blacklist service was not online in FortiOS 5.6.0. In FortiOS 5.6.1, a notification appears
on theDashboardwhen WAN IP is blacklisted. Clicking on the notification brings up the blacklist details.

Application Control GUI improvements (279956)

An All Categories button on the Security Profiles > Application Control page makes it easier to apply an
action (Monitor, Allow, Block, Quarantine) to all categories at once.

Note that the All Categories selector goes blank when any of theactions to be applied to individual categories is
manually changed to something different than what was selected for all the categories. The Unknown
Application action will match the All Categories action unless that action is Quarantine, which is unsupported
for unknown applications.

Industrial Application Control signatures (434592)

The application control category Industrial is now controlled by a FortiGuard license and the default disable mask
is no longer needed. The special category is also no longer used.

GUI updates to reflect package and license changes for IPS, Application Control and
Industrial signatures (397010)

The following changes have been made to the GUI to reflect changes in the signature databases:

l Application Control signature database information is displayed under on the System > FortiGuard page in the
FortiCare section.

l The IPS package version and license status are shown in a separate section in System > FortiGuard page. A link
to manually upload the IPS database signatures has been added.

l The Industrial package version and license status are shown in a separate section in System > FortiGuard page.
A link to manually upload the Industrial database signatures is available. Access to the Industrial database is
provided with the purchase of the FortiGuard Industrial Security Service. The row item for this license will not
appear if you are not subscribed.

l Botnet category is no longer available when searching the Application Signatures list.

Improved FortiClient monitor display (378288)

The GUI for theMonitor > FortiClient Monitor page has been revised.
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l new dropdown option: Online Only or Include Offline. The default isOnline Only.
l new dropdown option

l Sending FortiTelemetry Only (default)
l Include All FortiTelemetry States
l Not Sending FortiTelemetry Only

l update: Compliance status for offline device isN/A
l update: offline status indicator to grey
l new compliance status text after the icon in Compliance column
l Moved Compliance column after Status column
l Combined unregistered endpoint devices with not registered devices

FortiSandbox integration with AntiVirus in quick mode (436380)

FortiSandbox options in an AntiVirus Security Profile in quick scanning mode can now be enabled with CLI
commands.

CLI syntax

config antivirus profile
edit default

set ftgd-analytics disable/everything
set analytics-max-upload 10
set analytics-wl-filetype 0
set analytics-bl-filetype 0
set analytics-db enable/disable
set scan-mode quick

end

Pre-configured parental controls for web filtering (399715)

Pre-configured filters based on the Motion Picture Association of America (MPAA) ratings can now be added to
the Web Filter Security Profile. This feature is already available on FortiCloud and uses the same ratings
categories.

Anti-Spam GUI updates (300423)

Changes made to the Anti-Spam profile update the GUI to reflect FortiOS 5.6 style.

FortiOS 5.6.0
These features first appeared in FortiOS 5.6.0.

Application control is now standard with FortiCare support

Application Control is now a standard part of any FortiCare support contract and the database for Application
Control signatures is separate from the Intrusion Prevention System (IPS) database. However, botnet application
signatures are still part of the IPS signature database since these are more closely related to security issues than
application detection.

With the release of FortiOS 5.6.1, the Application Control signature database information is displayed under the
System > FortiGuard page, in the FortiCare section. The botnet category is no longer available when you
search for the Application Signatures list.
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To receive updates to the Application Control signature database, you must have a
valid FortiCare support contract.

IPS / Application Control logging performance

There is a major boost to Application Control and IPS when logging is enabled. With the latest changes, the
performance difference with or without logging enabled is negligible.

CASI functionality moved into application control (385183, 372103)

Cloud Access Security Inspection (CASI) is merged with Application Control resulting in changes to the GUI and
the CLI.

GUI Changes

l Toggle option added to quickly filter CASI signatures in the Application Signatures list.
l Application Overrides table now shows any parent-child hierarchy using the --parent metadata on signatures.

Deleting a parent app also deletes its child apps. And conversely, adding a child app will add all its parent apps but
with implicit filter action.

l A policy breakdown is shown on existing application control profiles for policies using the profile. The breakdown
indicates which policies are using a deep inspection.

l A breakdown is shown for application categories and filter overrides to indicate the number of CASI and non-CASI
signatures. A lock icon is shown for applications requiring deep inspection.

CLI Changes

Commands removed:

l config application casi profile

l casi profile in config firewall policy

l casi profile in config firewall policy6

l casi-profile-status and casi-profile under config firewall sniffer

l casi-profile-status and casi-profile under config firewall interface-policy

Application control and Industrial signatures separate from IPS signatures (382053)

IPS, Application control and industrial signatures have been separated. The get system status command shows
the versions of each signature database:

get system status
Version: FortiGate-5001D v5.6.0,build1413,170121 (interim)
Virus-DB: 42.00330(2017-01-23 01:16)
Extended DB: 1.00000(2012-10-17 15:46)
Extreme DB: 1.00000(2012-10-17 15:47)
IPS-DB: 6.00741(2015-12-01 02:30)
IPS-ETDB: 0.00000(2001-01-01 00:00)
APP-DB: 6.00741(2015-12-01 02:30)
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Block Google QUIC protocol in default Application Control configuration (385190)

QUIC is an experimental protocol from Google. With recent Google Chrome versions (52 and above), and
updated Google services, more than half of connections to Google servers are now in QUIC. This affects the
accuracy of Application Control. The default configuration for Application control blocks QUIC.

Users may enable QUIC with CLI commands.

CLI Syntax

config application list
edit <profile-name>

set options allow-quic
end

FortiClient profile improvements (386267, 375049)

FortiClient profiles have been changed in FortiOS 5.6 to include new protection features and to change
organization of the GUI options. FortiClient profiles also use the FortiGate to warn or quarantine endpoints that
are not compliant with a FortiClient profile.

A bug that prevented the Dialog and Device Inventory pages from loading when there is a large number of
devices (for example, 10,000) has been fixed.

Default FortiClient profile

FortiClient profiles allow you to perform vulnerability scans on endpoints and make sure endpoints are running
compliant versions of FortiClient. Also, security posture features cause FortiClient to apply realtime protection,
AntiVirus, web filtering, and application control on endpoints.
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The default FortiClient profile also allows you to set a general Non-compliance action for endpoints that don't
have FortiClient installed on them. The non-compliance action can be block or warning and is applied by the
FortiGate. Blocked endpoints are quarantined by the FortiGate.

Endpoint vulnerability scanning

Similar to FortiOS 5.4 you can set the FortiClient Profile to run the FortiClient vulnerability scanner on endpoints
and you can set the Vulnerability quarantine level to quarantine endpoints that don't comply.

The vulnerability scan Non-compliance action can block or warn endpoints if the vulnerability scan shows they
do not meet the vulnerability quarantine level.

System compliance

FortiOS 5.6 system compliance settings are similar to those in 5.4 with the addition of a non-compliance action.
System compliance checking is performed by FortiClient but the non-compliance action is applied by the
FortiGate.

Security posture checking

Security posture checking collects realtime protection, antivirus protection, web filtering and application firewall
features under the Security Posture Check heading.
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FortiClient endpoint license updates (401721)

FortiClient endpoint licenses for FortiOS 5.6.0 can be purchased in multiples of 100. There is a maximum client
limit based on the FortiGate's model. FortiCare enforces the maximum limits when the customer is applying the
license to a model.

If you are using the ten free licenses for FortiClient, support is provided on the Fortinet Forum
(forum.fortinet.com). Phone support is only available for paid licenses.

Model(s) Maximum client limit

VM00 200

FGT/FWF 30 to 90 series 200

FGT 100 to 400 series 600

FGT 500 to 900 series, VM01, VM02 2,000

FGT 1000 to 2900 series 20,000

FGT 3000 to 3600 series, VM04 50,000

FGT 3700D and above, VM08 and above 100,000

Older FortiClient SKUs will still be valid and can be applied to FortiOS 5.4 and 5.6.

FortiClient Vulnerability Exemption Setting (407230)

A new CLI command provides a manual override for client computers with vulnerabilities that cannot be fixed.

2756 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

http://www.forum.fortinet.com/


What's new in FortiOS 5.6

CLI Syntax

New command to enable/disable compliance exemption for vulnerabilities that cannot be auto patched. Default
is disable.

config endpoint-control profile
edit <profile-name>

config forticlient-winmac-setting
set forticlient-vuln-scan enable
set forticlient-vuln-scan-exempt [enable|disable]

end
next

end

New FortiGuard Web Filter categories (407574)
New categories added to FortiGuard Web Filter sub-categories:

l Under Security Risk:
l Newly Observed Domain (5.90)
l Newly Registered Domain (5.91)

l Under General Interest - Business
l Charitable Organizations (7.92)
l Remote Access (7.93)
l Web Analytics (7.94)
l Online Meeting (7.95)

Newly observed domain (NOD) applies to URLs whose domain name is not rated and were observed for the first
time in the past 30 minutes.

Newly registered domain (NRD) applies to URLs whose domain name was registered in the previous 10 days.

Overall improvement to SSL inspection performance (405224)

The enabling / disabling of proxy cipher / kxp hardware acceleration in CP8/CP9 required restarting of the WAD
daemon for the change to take effect; this bug has been repaired.

New CLI commands

The FortiGate will use the ssl-queue-threshold command to determine the maximum queue size of the
CP SSL queue. In other words, if the SSL encryption/decryption task queue size is larger than the threshold, the
FortiGate will switch to use CPU rather than CP. If less, it will employ CP.

config firewall ssl setting
set ssl-queue-threshold <integer>

end

The integer represents the maximum length of the CP SSL queue. Once the queue is full, the proxy switches
cipher functions to the main CPU. The range is 0 - 512 and the default is 32.

DNS profile supports safe search (403275)

Users can take advantage of pre-defined DNS doctor rules to edit DNS profiles and provide safe search for
Google, Bing, and YouTube.
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To add safe search to a DNS profile - GUI

1. Go to Security Profiles > DNS Filter.
2. Edit the default filter or create a new one.
3. Enable Enforce 'Safe Search on Google, Bing, YouTube'.
4. Select Strict orModerate level of restriction for YouTube Access.

To add safe search to a DNS profile - CLI

config dnsfilter profile
edit "default"

set safe-search enable
set youtube-restrict {strict | moderate} (only available is safe-search enabled)

next
end

Changes to default SSL inspection configuration (380736)

SSL inspection is mandatory in the CLI and GUI and is enabled by default.

GUI Changes

l Updated edit dialogues for IPv4/IPv6 Policy and Explicit Proxy Policy
l SSL/SSH inspection data displayed in muted palette
l disabled the toggle button for this option
l set the default profile as "certificate-inspection"

l Updated list pages for IPv4/IPv6 Policy and Explicit Proxy Policy
l Add validation for "ssl-ssh-profile" when configuring UTM profiles

l Updated SSL/SSH Inspection list page
l disabled delete menu on GUI for default ssl profiles
l changed "Edit" menu to "View" menu for default ssl profiles
l added implicit class (grayed) the default ssl profile entries

l Updated SSL/SSH Inspection edit dialog
l disabled all the inputs for default ssl profiles except download/view trusted certificate links
l changed button to "Return" for default ssl profiles to return the list page

l Updated Profile Group edit dialog
l removed checkbox for "ssl-ssh-profile" option, make it always required.

CLI changes

1. ssl-ssh-profile default value is certificate-inspection when applicable in table firewall.profile-
group, firewall.policy, firewall.policy6, firewall.proxy-policy

2. make default profiles "certificate-inspection", "deep-ssl-inspection' read only in table firewall.ssl-ssh-profile

Botnet database changes (390756)

Starting in FortiOS 5.6, FortiGate units and FortiGuard Distribution Servers (FDS0 will use object IDs IBDB and
DBDB to download and update the Botnet database. Botnet protection will be part of the AntiVirus contract.

FortiOS 5.4 uses object IDs IRDB and BDDB.
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Fortinet Security Fabric audit check for endpoint vulnerability and unauthorized FAP and FSW
(401462)

The new Security Fabric Audit feature allows for the display of endpoint vulnerability status in real-time. Users
can see:

l FortiClient devices that have critical vulnerabilities detected.
l Discovered FortiSwitches that have not yet been authorized.
l Discovered FortiAPs that have not yet been authorized.

Change to CLI commands for configuring custom Internet services (397029)

Custom internet services are no longer configured through use of the commands config application
internet-service and config application internet-service-custom in the CLI.

These commands are replaced by config firewall internet-service and config firewall
internet-service-custom.

CLI Syntax - examples

config firewall internet-service 1245324
set name "Fortinet-FortiGuard"
set reputation 5
set icon-id 140
set offset 1602565

config entry
edit 1

set protocol 6
set port 443
set ip-range-number 27
set ip-number 80

next
edit 2

set protocol 6
set port 8890
set ip-range-number 27
set ip-number 80

next
edit 3

set protocol 17
set port 53
set ip-range-number 18
set ip-number 31

next
edit 4

set protocol 17
set port 8888
set ip-range-number 18
set ip-number 31

next
end

end

config firewall internet-service-custom
edit "custom1"

set comment "custom1"
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config entry
edit 1

set protocol 6
config port-range

edit 1
set start-port 30
set end-port 33

next
end
set dst "google-drive" "icloud"

next
end

next
end

Enable "sync-session-ttl" in "config ips global" CLI by default (399737)

sync-session-ttl is now set to enable by default in order to:

l enhance detection of P2P traffic. Efficient detection of P2P is important on hardware accelerated platforms
l ensure that IPS and the kernel use the same ttl
l ensure that IPS sessions time out sooner

New diagnose command to delete avatars (388634)

Commands to delete avatars by FortiClient UID or avatar name have been added to the CLI.

the two following commands has been added to diagnose endpoint avatar:

l diagnose endpoint avatar delete <ftcl_uid>

l diagnose endpoint avatar delete <ftcl_uid> <username>

The attribute delete did not exist before. The values <fctl_uid> and <user_name> describe a set of
avatars. If only <fctl_uid> is defined, all avatars belonging to this FortiClient UID that are not being used will
be removed. If both values are defined, the avatar belonging to them will be removed unless they are being used
in which case this call will cause an error to user.

Fortinet bar option disabled in profile protocol options when VDOM is in flow-based
inspection mode (384953)

In order to prevent the Fortinet Bar from being enabled and redirecting traffic to proxy (WAD) when a VDOM is in
flow-based mode, the Fortinet Bar option is disabled in profile protocol options.

SSL/SSH profile certificate handling changes (373835)

In order to support DSA and ECDSA key exchange (in addition to RSA) in SSL resign and replace mode, CLI
commands for deep-inspection have changed. The certname command in ssl-ssh-profile has
been removed.

To select from the list of available certificates in the system, use the CLI below.

edit deep-inspection
set server-cert-mode re-sign
set certname-{rsa | dsa | ecdsa}
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Restricting access to YouTube (replacement for the YouTube Education filter feature)
(378277)

Previous versions of FortiOS supported YouTube for Schools (YTfS). As of July 1, 2016 this feature is no longer
supported by YouTube. Instead you can use the information in the YouTube support article Restrict YouTube
content on your network or managed devices to achieve the same result. FortiOS supports applying Strict or
Moderate restrictions using HTTP headers as described in this article.

In FortiOS 5.6 with inspection mode set to proxy-based, in a Web Filter profile under Search Engines you can
select Restrict YouTube Access and select either Strict orModerate.

Enhancements to IPS Signatures page (285543)

The IPS signatures list page now shows which IPS package is currently deployed. Users can also change their IPS
package by linking directly to the FortiGate'sSystem > FortiGuard page from the IPS Signatures list page.

DLP sensor GUI changes (307225)

The DLP sensor for file size has been corrected to indicate that the file size has to be greater than the number of
KB entered. Previously, the GUI incorrectly showed that the files size could be greater than or equal to the
number of KB entered.

Web Filter profile page GUI updates (309012)

The GUI for theWeb Filter security profile andWeb Profile Overrides pages are changed.

Web Filter profile page

l removed multilist for override user group and profile
l replaced FortiGuard categories actions icons with font icons
l added tooltip forAllow users to override blocked categories to explain the policy group dependency

Web Profile Overrides page

l removed multilist of user, user group, original profile, new profile
l duplicate profile for new profile (for bug #284239)

Web Filter Quota traffic can no longer be set to 0 (374380)

To fix a bug in older major release, the CLI has been changed so that minimum traffic quota does not allow 0 as
an entry. The value entered must be in the range of 1 - 4,294,967,295; if 0 is entered, then an error message will
be returned.
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CLI Commands:

config webfilter profile
edit default

config ftgd-wf
config quota

edit 1
set type traffic
set value {a number in the range of 1 - 4,294,967,295}

Webcache-https and SSL deep inspection profile configuration changes (381101)

In older releases, the CLI blocked the configuration of the SSL deep inspection profile when webcache-https was
enabled. This bug is fixed in FortiOS 5.6.0.

FortiGate conserve mode changes (242562, 386503)

The following changes were made to rework conserve mode and facilitate its implementation:

l Implemented CLI commands to configure extreme, red, and greenmemory usage thresholds in percentages of
total RAM. Memory used is the criteria for these thresholds, and set at 95% (extreme), 88% (red) and 82% (green).

l Removed structure av_conserve_mode, other changes in kernel to obtain and set memory usage thresholds from
the kernel

l Added conserve mode diagnostic command diag hardware sysinfo conserve, which displays information
about memory conserve mode.

l Fixed conserve mode logs in the kernel
l Added conserve mode stats to the proxy daemon through command diag sys proxy stats all | grep
conserve_mode

New custom IPS and Application Control Signatures list (280954)

You can now create IPS and Application control custom signatures by going to Security Profiles > Custom
Signatures. From here you can create and edit all custom IPS and Application Control signatures.

Default inspection mode set to flow-based (377392)

In FortiOS 5.6.0, the following changes were made to inspection mode:

l factory default sets the FortiGate to flow-based inspection with VDOM disabled
l whenever a VDOM is created, the default inspection mode is flow-based
l when in flow-based inspection mode, the Inspection Mode will not appear on the Dashboard; it will appear when in

proxy-based inspection mode.

You must use the CLI to set the FortiGate to proxy-based inspection. To change the inspection mode back to
flow-based inspection, you may use the GUI or the CLI.

config system settings
edit <name_str>
set inspection-mode {proxy | flow}

end
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Inside FortiOS: AntiVirus

AntiVirus uses a suite of integrated security technologies to provide against a variety of threats, including both
known and unknown malicious codes (Malware), plus Advanced Targeted Attacks (ATA), also known as Advanced
Persistent Threats (APT).

Advanced Protection against Malware and APTs
Malware and Advanced Persistent Threats can cause significant damages to today’s organizations. These
malicious codes are commonly designed to steal valuable data, gain unauthorized access, or cause products to
degrade. FortiOS’s AntiVirus is an industry-proven anti-malware security solution with robust features and
deployment options

FortiOS offers the unique ability to implement both Flow- and Proxy-based AV concurrently, depending on traffic
type, users, and locations. Flow-based AV offers higher throughput performance while proxy-based solutions are
useful in mitigating stealthy malicious codes. The AV detection capabilities are further enhanced with
complementary security features and external sandbox integration.

By utilizing the unique Content Pattern Recognition Language (CPRL) built into the FortiASIC Content Processor,
FortiOS is able to deliver high performance and low latency anti-malware capabilities. This real-time protection is
backed by a team of worldwide researchers.

Highlights

l Certification from multiple industries for best-in-class security and capacity with proven coverage and high
performance.

l Multi-layered protection with extended AV components and external file analysis integration.
l Comprehensive remediation actions such as file quarantine and knowledge tools.

Key Features & Benefits

Robust feature set Allows the flexibility to deploy appropriate protection according
to security needs and infrastructure designs.

High performance utilizing FortiASIC and
patented CPRL AV signatures

Low latency and high capacity ensures that business
applications are not affected while security is enforced.

Backed by FortiGuard Labs that deliver
real-time protection

Critical digital assets are covered by continuous protection
against latest threats.

Features

Industry’s Validated Protection

FortiOS anti-malware components and FortiGuard AV signatures periodically undergo numerous authoritative
certifications. These independent certifications demonstrate that the solution offered is of the highest standard in
performance and accuracy, ensuring organizations are truly protected.
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Fortinet has been consistently ranked among the top vendors for Virus Bulletin’s RAP (Reactive And Proactive)
bimonthly tests. This test measures a product’s detection rates over the freshest samples available, as well as
samples not seen until after product databases are frozen, thus reflecting both the vendor’s ability to handle the
huge quantity of newly emerging malware and accurately detect previously unknown malware.

Real Time Protection

The FortiGuard AntiVirus Service provides fully automated updates to ensure protection against the latest
content-level threats via the experienced FortiGuard global network is backed by over 200 researchers. With the
release of FortiOS 5.6, botnet protection is part of the FortiGuard AntiVirus contract.

FortiGuard AV service quick facts
l 95,000 malware programs neutralized per minute
l 1.8 Million new and updated AV definitions per week
l Hourly updates of the AV signature database
l 190 TB of threat samples till date

Organizations can also engage the FortiGuard Premier Signature Service, which provides enhanced virus
detection and threat analysis support. This service offers submissions for custom AntiVirus signatures on a daily
basis, offering prioritized support with guaranteed response times. With the release of FortiOS 5.6, botnet
protection is part of the FortiGuard AntiVirus contract.

Unique Proxy and Flow Based AV

FortiOS offers organizations the flexibility to select the most appropriate inspection method for different network
sessions. This can be implemented by defining policies that match specific source objects (IP, IP ranges, users,
and devices), destination objects, applications, and schedules with different AV profiles.

Flow-based AV relies on IPS technology where packets are inspected in real-time and matched against the AV
signature database. It offers lower latency and higher throughput than Proxy-based AV. Flow-based AV is
recommended for inspecting traffic that requires spontaneous user experience or when serving as an additional
AV protection layer.

FortiOS’s Proxy-based AV offers the most secure AV protection as it’s able to inspect more protocols and provides
replacement messages on wider range of applications.

AV Acceleration with Content Processor

The FortiASICSContent Processor (CP) accelerates content processing traditionally performed completely by the
CPU. The CP reduces the resources required by the CPU when matching an incoming file against the signature
database, thus improving system performance and stability.
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Proactive Protection using Patented CPRL

Compact Pattern Recognition Language (CPRL) is a patented and proprietary programming language that allows
for further inspection of common patterns to not only protect against threats and their variants but also to predict
tomorrow’s zero-day malware. It allows FortiGuard analysts to describe entire families of malware with a single
program, instead of the traditional signature- based “one signature, one variant” model used by other vendors.
With fewer signatures to match, throughput performance and latency naturally improve.

Intelligent Behavioral Evaluation

Signature-based security alone is no longer sufficient; it is now critical to understand how devices on your network
are behaving. Threat Weight scoring provides a cumulative security ranking of each client device on your network
based on a range of behaviors. It provides specific, actionable information that helps identify compromised
systems and potential zero-day attacks in real-time.

This unique system attaches predefined scores to various malicious network activities discovered by IPS,
application control, URL filtering, etc., to determine the top suspicious users. Administrator can then further
inspect these users to undercover unknown threats or APTs via FortiView.

External File Analysis Integration

FortiOS offers organizations the ability to adopt robust ATP (Advanced Threat Protection) framework that reaches
mobile users and branch offices, detecting and preventing advanced attacks that may bypass traditional defenses
by examining files from various vectors, including encrypted files. To detect unknown threats, zero-day, and
targeted attacks, the FortiGate can engage external resources to perform additional file analysis. Files can be
submitted to an on- premise appliance (FortiSandbox) or cloud-based service (FortiSandbox Cloud) after both
proxy-based and flow- based AV processing.

It is also possible to configure the FortiGate to automatically receive dynamic signature updates from
FortiSandbox and add the originating URL of any malicious file to a blocked URL list. In addition, if the
organization deploys integrated endpoint control with FortiClient, an administrator can instruct an infected
terminal to self-quarantine.
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File Filtering

File filtering using data leak prevention (DLP) on the FortiGate offers an effective ways to stop unwanted file
transmission instantly. Administrators may implement granular file controls by defining protection profiles using
filenames or nearly 50 different file types over mail, web, and file download protocols.

File Quarantine

FortiOS offers sophisticated file quarantine capabilities that allow organizations to archive suspicious or blocked
files for further examination or to release false positives.

Anti-bot

Organizations may prevent, uncover, and block botnet activities using FortiOS Anti-Bot traffic pattern detection
and domain and IP reputation services supplied in real-time by FortiGuard threat experts.

User Notification

User notifications are helpful in reducing administration and support burdens, as well as providing user education.
FortiOS is able to automatically replace blocked attachments and downloads with detailed information sent to E-
mail, FTP, or web users.

Monitoring, Logging, and Reporting

FortiOS empowers organizations to implement security best practices that require continuous examination of
their threat status and adaptation to new requirements. The FortiView widgets provide useful analysis data with
detailed and contextual session information, which can be filtered, ranked, and further inspected. System events
can also be archived via logs, which in turn can generate useful trending and overview reports.

FortiOS also offers robust in-built E-mail and SMS alert systems, as well as integration with external threat
management systems using SNMP and standard-based Syslogs.

Inside FortiOS: Application Control

Application control technologies detect and take action against network traffic based on the application that
generated the traffic. Application control uses protocol decoders with signatures that analyze network traffic to
detect application traffic, even if the traffic uses nonstandard ports or protocols.

Enhance Control and Network Visibility
Controlling and monitoring applications on a network can seem like a daunting task due to the wide range of
available applications. It is no longer an option to simply block or allow TCP and/or UDP ports since most
applications do not map to individual ports. For example, controlling traffic on an HTTP or HTTPS port is futile
against complex social networking sites and cloud applications.

FortiOS leverages its massive application database to identify applications and their activities while still providing
a suitable and sufficient user experience, thanks to FortiASIC Content Processors (CPs), which boost CPU
performance. Organizations can adopt more granular control, such as allowing logins but not chatting over
selected sites. Traffic shaping may also be applied to the application traffic that is allowed. After applying control
measures, continuous monitoring ensures that the measures are effective and allow for changes in application
traffic patterns to be managed.
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Highlights

l Superior performance using the unique FortiASIC Content Processor that offloads heavy computation from the
CPU.

l Flexible implementation with robust deployment modes and granular controls.
l Excellent visibility and management tools that help administrators improve security.
l Application control is a standard part of any FortiCare support contract and the database for application control

signatures is separate from the IPS database. You don't require a FortiGuard IPS subscription to access the
database.

To receive updates to the Application Control signature database, you must have a
valid FortiCare support contract.

l Supports detection for traffic using HTTP protocol (versions 1.0, 1.1, and 2.0).
l Ability to configure application control by adding individual applications or application categories to security policies

when operating in flow-based inspection and NGFW policy-based mode.

Key Features & Benefits

Identifies and controls application traffic Allows organization to strengthen security policies by controlling
evasive application communications.

Leverages FortiGate’s hardware
acceleration and software optimization

Offers more security without compromising performance.

Granular control and integration with
other FortiOS capabilities

Provides administrators the ability to implement the most
appropriate configuration for any given organization.

Features

NSS Labs “Recommend” Rating for Next Generation Firewall

Fortinet’s entry into the NSS Labs Next Generation Firewall Group Test in 2013, 2014 and 2016 received the
“Recommend” rating, placing it as one of the top performing systems. NSS Labs uses respectable real-world
testing methodologies to measure Next Generation Firewall protection and performance, including application
control.

Superior performance with Unique Hardware Architecture

Unlike a traditional security gateway, which relies heavily on CPUs for packet inspection, the FortiGate’s unique
hardware architecture allows FortiOS to automatically utilize appropriate hardware components to achieve
optimal performance. This prevents the CPU from becoming a bottleneck as it performs various functions
concurrently.

In support of application control, the Content Processor (CP) is a specialized ASIC chip that handles demanding
cryptographic computation for SSL inspection and intensive signature matching. By offloading these processes
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from the CPU, the FortiGate is able to minimize performance degradation when administrators opt for greater
security.

Robust Deployment Modes

FortiOS supports a wide array of network protocols and operating modes, allowing administrators to deploy the
most appropriate security for their unique IT infrastructure. FortiOS also supports a variety of routing and
switching protocols.

The FortiGate is able to operate in inline route and transparent mode. It can also operate in offline sniffer mode
for passive monitoring of user activities. These different operating modes run concurrently by using virtual
systems.

Protection at the Edge

With today’s BYOD and mobile workforce environment, it is no longer wise to deploy control just at the Internet
gateway. Through Fortinet Security Fabric, FortiOS unique wireless and switch controller feature allows
organizations to implement better visibility and protection closer to internal devices. Moreover, with FortiClient,
administrators can also apply similar policies when mobile users are outside of the protected networks.

Advanced Application Detection and Control

By relying on the FortiOS 3rd Generation IPS engine, the FortiGate is able to inspect many of today’s encrypted
and evasive traffic, as well as traffic running on new technologies, such as SPDY protocol. The inspection can be
applied to both network and IPsec/SSL VPN traffic.

An application and its specific activity are identified using FortiGuard’s Application Control database of over 2,500
distinct signatures. These signatures are crafted by researchers across the globe to include applications that may
be unique to platforms, regions, and/or languages. It also offers specific application activity identification, such as
a Facebook posting or Dropbox file sync. The database is kept up to date via scheduled or manual downloads.

The application database is classified into 20 intuitive categories for ease of use. Administrators may also create
specific application overrides that differ from the category settings. These specific applications can be filtered and
selected by type of behavior, risk levels, technology type, application vendor and popularity.

Administrators may also apply advanced controls, such as setting up session TTLs for specific applications using
CLI commands.

Traffic Shaping

Organizations may better utilize bandwidth and protect critical applications by enforcing granular application
usage with traffic shaping. Administrators can create various traffic shaping profiles by defining traffic priority and
maximum or guaranteed bandwidth. These profiles can then be assigned to targeted applications.
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User Notification

User education is central to an effective security implementation. In response to this, FortiOS lets you provide
user notification when blocking an unauthorized application. The notification appears as an HTML block page for
web-based applications.

Advanced notification is possible by implementing Fortinet’s browser-embedded frame. And when “off-net” users
are denied access, notifications appear via FortiClient’s notification pop-ups.

Deep Inspection for Cloud Applications

The prevalence of cloud applications like Dropbox poses a security challenge to today’s organizations. Using
FortiOS’s deep inspection for popular cloud applications, administrators gain deep and useful insights, via
FortiView and logs, into activities associated with these applications, such as user IDs, cloud actions, file names,
and file sizes. For popular video sites, FortiOS will also be able to track video files viewed.

SSL Inspection for Encrypted Traffic

SSL (Secure Sockets Layer) is a popular encryption standard used to protect Internet traffic but may also be used
to evade traditional inspection. FortiOS enables organizations to adopt effective application control even when
traffic is encrypted.

Unique hardware components and software optimizations can decrypt traffic with minimal performance impact.
The inspection can easily omit sensitive communications, such as financial transaction (thereby complying with
privacy policies), or bypass applications that forbid SSL inspection by using granular policy settings.
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Monitoring, Logging, and Reporting

FortiOS empowers organization to implement security best practices that require continuous examination of
threat statuses and the ability to adapt to new requirements.

The FortiView widgets provide useful analyses with detailed and contextual session information that can be
filtered, ranked, and further inspected. For example, an administrator can instantly query the top applications that
are currently consuming bandwidth and drill down to identify their users and help decide if such activities should
be blocked.

Network, threat, and system events activities can be archived via syslogs. In turn, these logs can generate useful
trending and overview reports.

Lastly, the FortiOS offers robust in-built email and SMS alert systems. Meanwhile, integration with external
threat management systems can be achieved with SNMP and standard-based syslogs.

Recipes
Visit cookbook.fortinet.com for these and other recipes:

l NGFW policy-based mode

Inside FortiOS: Intrusion Prevention System (IPS)

Intrusion Prevention System (IPS) technology protects your network from cybercriminal attacks by actively
seeking and blocking external threats before they can reach potentially vulnerable network devices.

World Class Next Generation IPS Capabilities
Today, sophisticated and high volume attacks are the challenges that every organization must recognize. These
attacks are evolving, infiltrating ever-increasing vectors and complex network environments. The result is an
urgent need for network protection while maintaining the ability to efficiently provide demanding services and
applications.

FortiOS’s IPS functionality is an industry-proven network security solution that scales up to over 200 Gbps of in-
line protection. Powered by purpose-built hardware and FortiASICs, FortiOS is able to achieve attractive TCO
while meeting performance requirements. IPS is easy to set up, yet offers feature-rich capabilities, with
contextual visibility and coverage. It is kept up-to-date by research teams that work 24 hours a day worldwide, in
order to detect and deter the latest known threats as well as zero-day attacks.

Highlights

l Validated best-in-class security and capacity with proven coverage and high performance.
l Comprehensive protection provided by a signatures-based IPS engine, protocol anomaly scanning, and DDOS

mitigation.
l Flexible deployment options and actionable implementations for a wide array of network integration and operation

requirements.
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Key Features & Benefits

High Performance IPS,
powered by FortiASIC

Low latency and high capacity ensure business applications are not affected while
security is enforced.

Best-in-class security with
superior coverage

Protects critical digital resources from both internal exploits and external
cybercriminals, even if sophisticated attacks are crafted.

Backed by FortiGuard
Labs that deliver real-time
protection

Maintains up-to-date and proactive protection against latest known threats and
newly discovered hacking techniques while allowing time for organizations to patch
vulnerable systems.

Features

Tested and Proven Protection

Not only have FortiGates been deployed in some of the largest enterprises in the world since 2002, FortiOS IPS
components and FortiGuard IPS signatures are periodically tested and certified by well-known external labs. For
example, Fortinet’s FortiGate 3000D earned the highest ratings for Security Effectiveness, blocking 99.9 percent
of exploits in the recent NSS Labs DCIPS test. These independent certifications ensure that solutions delivered to
customers are of the highest standards in performance, coverage, and accuracy.

Real-Time & Zero-day Protection

The FortiGuard Intrusion Prevention Service (IPS) provides customers with the latest defenses against stealthy
network-level threats through a constantly updated database of known threats and behavior-based signatures.

FortiGuard IPS service quick facts
l Over 10,000 signatures consisting of 18,000 rules
l Approximately 470,000 network intrusion attempts resisted per
minute

l About 1,000 rules are updated or added per week
l Over 300 Zero-day vulnerabilities discovered to date

This update service is backed by a team of threat experts and a close relationship with major application vendors.
The best-in-class team also uncovers significant zero-day vulnerabilities continuously, providing FortiGate units
with advanced protection ahead of vendor patches.

Uncompromised Performance

The FortiASICSContent Processor (CP) accelerates content processing, which is traditionally done completely by
the CPU. The CP reduces the resources required by the CPU when matching an incoming file against the
signature database, thus improving system performance and stability.

Protocol Decoders and Anomaly Detection

Protocol decoders are required to assemble the packets and detect suspicious, nonconforming sessions that
resemble known attacks or are non-compliant to RFC or standard implementation.
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FortiOS offers one of the most comprehensive arrays of protocol decoders in the industry, providing customers
with significantly wide coverage in all kinds of environments.

Pattern & Rate-Based Signatures

The pattern signature matching technique is essential in IPS implementation due to its high level of precision and
accuracy. FortiOS offers administrators robust pattern signature selection using filters based on severity, target,
operating system, application, and protocol. Each of the 10,000+ signatures has a direct link to its detailed entry
on the threat encyclopedia and CVE-ID references. After selection, administrators are able to assign associated
actions such as monitoring, blocking, or resetting the session.

Rate-based IPS signatures protect networks against application based DoS and brute force attacks.
Administrators can configure nearly 30 rate-based IPS signatures and tune them to their needs. Threshold
(incidents per minute) and an action to take when the threshold is reached can be assigned to each signature. If
the action is set to block, then a timeout period can be set so that the block is removed after a specified duration.

DoS and DDoS Mitigation

DoS policies can help protect against DDoS attacks that aim to overwhelm server resources. In FortiOS, the DoS
scans precede the policy engine at the incoming interfaces, thus eliminating unnecessary sessions from the
firewall process and state table entry during a surge of attack traffic. This helps to safeguard the firewall from
overloading and allows it to perform optimally.

FortiOS DoS policies can be configured to detect and block floodings, port scans, and sweeps. Administrators can
set baselines for the amount of concurrent sessions from sources or to destinations. The settings utilize
thresholds and can be applied to UDP, TCP, ICMP, IP, and SCTP.

Network interfaces associated with a port attached to a Network Processor (NP) can be configured to offload
anomaly checking, further offloading the CPU for greater performance. Some of the anomaly traffic dropped
includes LAND attacks, IP protocol with malformed options, and WinNukes.

Quarantine Attacks

FortiOS offers sophisticated automatic attack quarantine capabilities which allow organizations to proactively
prevent further attacks from known attackers over a predefined duration. Quarantining by duration can be used to
protect potentially vulnerable servers until more permanent defense.

Packet Logging

Administrators may choose to automatically perform IPS packet logging, which saves packets for detailed
analysis when an IPS signature is matched. Saved packets can be viewed and analyzed on the FortiGate unit or
by using third-party analysis tools. Packet logging is also useful in determining false positives.

Custom Signatures

Custom IPS signatures can be created to further extend protection. For example, you can use custom IPS
signatures to protect unusual or specialized applications, or even custom platforms from known and unknown
attacks.

Organizations may use FortiConverter to easily convert Snort signatures for FortiOS use.
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Resistant Against Evasions

Evasion techniques attempt to fool the protocol decoders in IPS products by crafting exotic network streams that
would not be handled or reconstructed by the decoders, yet still be valid enough for the target recipient to
process. Robust IPS engine is capable of handling both common evasions and sophisticated AETs (Advanced
Evasion Techniques) deployed by hackers such as IP Packet Fragmentation, TCP Stream Segmentation, RPC
Fragmentation, URL &HTML Obfuscation, and other protocol specific evasion techniques.

Intrusion Detection Mode

In out-of-band sniffer mode (or one-arm IPSmode), IPS operates as an Intrusion Detection System (IDS),
detecting attacks and reporting them but not taking any action against them. In sniffer mode, the FortiGate unit
does not process network traffic and instead is connected to a spanning or mirrored switch port, or a network tap.
If an attack is detected, log messages can be recorded and alerts sent to system administrators.

Traffic Bypass

Since most IPS deployments are in transparent inline mode, active traffic bypass is often desired until normal
operation of the device resumes. Some FortiGates offer inbuilt active bypass interfaces while others may use
external bypass devices such as the FortiBridge. Administrators are also offered with software fail-open option to
tackle instances where the IPS engine fails.

Monitoring, Logging, and Reporting

FortiOS empowers organizations to implement security best practices that require continuous examination of
their threat status and adaptation to new requirements. The FortiView query widgets provide useful analysis data
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with detailed and contextual session information, which can be filtered, ranked, and further inspected. System
events can also be archived via logs, which in turn can generate useful trending and overview reports.

Inside FortiOS: Web Filtering

AWeb Filtering solution is designed to restrict or control the content a reader is authorized to access, delivered
over the Internet via the Web browser. It may be used to improve security, prevent objectionable activities, and
increase productive within an organization.

Intelligent and Effective Content Control
Web-based threats such as Phishing, drive-by Malware sites, and Botnets are more sophisticated and scrutinized
than ever, and as well as increasingly difficult to control due to the rise of mobility in the workplace, even more
difficult for you to control. The Web has become the preferred medium of choice for hackers and thieves looking
for new ways to disrupt services, steal information, and perform malicious activities for financial gain. In addition,
employees who visit websites containing objectionable content can expose your organization to civil or criminal
liability.

FortiOSWeb Filtering solution utilizes three main components of the web filtering function: the Web Content
Filter, the URL Filter, and the FortiGuard Web Filtering Service. These functions integrate with each other to
provide maximum control over what the Internet user can view as well as protection to the network from many
Internet content threats. Web Content Filtering blocks web pages containing words or patterns that you specify.
URL filtering uses URLs and URL patterns to block or exempt web pages from specific sources. FortiGuard Web
Filtering provides many additional categories you can use to filter web traffic by independent real-world tests.

Highlights

l Comprehensive and advanced Web Filtering features Safe Search and user override options.
l FortiGuard Web Filtering Services with superior coverage of over 250 million rated websites.
l Integration with other FortiOS components, such as User Identification for flexible and secured implementation.
l Supports detection for traffic using HTTP protocol (versions 1.0, 1.1, and 2.0).
l Ability to configure web filtering by adding URL categories to security policies when operating in flow-based

inspection and NGFW policy-based mode. You can set the action to accept or deny to allow or block the
applications.

Key Features & Benefits

Cloud-based Rating Database Real-time website category rating provides accurate content control.

Wide choice of web filtering
technologies

Various web filtering technology options are available to provide each
organization the most suitable implementation.

Integrated with other security and
networking functions

Allows organizations to simplified networks and reduce TCO.

2774 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Inside FortiOS: Web Filtering

Features

Cloud-based Rating System

Fortinet is a pioneer in cloud-based rating systems for web filtering. FortiOS provides an innovative approach to
HTTP and HTTPSweb filtering technology by combining the advantages of a cloud-based service offering with
layered response caching. The multiple FortiGuard data centers around the world hold the entire categorized
URL database and receive rating requests from FortiGate units triggered by browser-based URL requests.
FortiGuard responds to these rating requests with the categories stored for specific URLs, the requesting
FortiGate unit then uses its own local profile configuration to determine what action is appropriate to the
category, such as: blocking, monitoring, allowing the page, displaying a warning, or requiring authentication to
view the page.

Rating responses are also cached directly in FortiGate unit memory so that ratings for frequently used sites can
be retrieved directly from the cache, reducing the number of requests to the FortiGuard network. Caching URLs in
memory makes URL lookups almost instantaneous while only using a very small amount of system memory.

An appropriately licensed FortiManager appliance can be synchronized to the FortiGuard network and as such
can be used in the same way to as the FortiGuard network for managed FortiGate devices. This can further
reduce any latency associated with the round trip time for individual rating requests while at the same time
ensuring complete database coverage. Consider the combination of a LAN attached FortiGate cluster and
FortiManager combination with the potential to handle tens of thousands of requests per second.

Superior Coverage

FortiGuard Web Filter ratings are performed by a combination of proprietary methods including text analysis,
exploitation of the web structure, and human raters. This service currently rates more than 250 million sites
covering billions of URLs with each site able to be rated in multiple categories. The FortiGuard database provides
a truly international service with support for 70 languages.

Extensive and Flexible Categorization

Rated URLs are assigned into one of the 98 categories (including 20 user defined ones) which administrators can
then easily manage and control. Administrators can configure and populate local categories or place specific
URLs in existing categories should the FortiGuard rating not be in agreement with an organization’s policies and
practices.

Rating Override

At times, administrators may have to allow approved people to access what they need during periods when an
exception to the normal rules is required, while still having enough control that the organization’s web usage
policies are not compromised. FortiOS can provide such setup by using alternate profiles.

Protection against Malicious URLs

The malicious URL database contains all malicious URLs active in the last month and is organized as one of the
categories. With Fortinet Security Fabric, customers can further their protection by having the FortiSandbox add
newly discovered URLs to a dynamic URL filter, thus blocking files from being downloaded again from that URL.
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Inspection Modes

FortiOS web filtering can operate in different modes: proxy-based and flow-based inspection modes and DNS
filtering. Each mode has strengths and weaknesses and all three can be active at the same time on different
traffic streams.

Proxy-based web filtering uses a proxy to assemble and analyze web content as it passes through the FortiGate
unit. If a page is blocked the proxy can replace the blocked page with a customizable web page informing users
that the page is blocked. Proxy-based web filtering is the most feature-rich mode, supporting many advanced
filters including web content filtering that analyzes web page content according to your custom requirements,
Java applet filtering, and blocking invalid URLs.

Flow-based web filtering uses the FortiOS IPS engine to filter web content packets as they pass through the
FortiGate unit without any buffering. Flow-based inspection does not use a proxy, so inspected packets are not
proxied and altered by the FortiGate unit. Flow-based inspection does not support as many advanced features as
proxy-based web filtering.

To control your FortiGate's security profile inspection mode in FortiOS 5.6, you can select Flow or Proxy
Inspection Mode from System > Settings. Having control over flow and proxy mode is helpful if you want to
ensure that only flow inspection mode is used.

In most cases proxy mode is preferred because more security profile features are available and more
configuration options for these individual features are available. Some implementations, however, may require all
security profile scanning to only use flow mode. In this case, you can set your FortiGate to flow mode knowing
that proxy mode inspection will not be used.

Two new policy modes are available in FortiOS 5.6.

l NGFWmode simplifies applying application control and web filtering to traffic by allowing you to add applications
and web filtering profiles directly to policies. This is used in conjunction with flow-based inspection.

l Transparent proxy allows you to apply web authentication to HTTP traffic without using the explicit proxy.

DNS web filtering employs DNS lookups to the FortiGuard DNS service to get web page ratings. Filtering is
done as part of the DNS lookup and web pages can be blocked or redirected to a web filter block page before the
HTTP session starts. As a result, it is lightweight in terms of resource usage although it only supports a limited
number of advanced features.

Usage Quota

Administrators can set a daily timed access quota by category or category group. Quotas allow access for a
specified length of time or traffic volume, calculated separately for each user.

Safe Search

SafeSearch is a feature of popular search sites that prevents explicit web sites and images from appearing in
search results. Although SafeSearch is a useful tool, especially in educational environments, the resourceful user
may be able to simply turn it off. Enabling SafeSearch on the FortiGate for the supported search sites can better
enforce its use by rewriting the search URL to include the code to indicate the use of the SafeSearch feature.

Restrict YouTube Access

In FortiOS 5.6 with inspection mode set to proxy-based, you can set Strict or Moderate access to YouTube in a
Web Filter profile.
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Manual URL and Content Filter

FortiOS web filtering offers specific URL filtering by standard, wildcard, and regular expression definition, as well
as content filtering by pattern type and language.

Advanced web filter configurations

FortiOS rich feature set includes ability to implement a number of enterprise features such as:

l Block HTTP redirects by rating, invalid URLs, HTTP POST actions, and Web resume download
l Cookie, Java applet, and ActiveX filter
l Rate Images by URL and URLs by domain and IP address
l Restrict Google account usage to specific domains

Proxy Avoidance Preventions

FortiGate is able to improve the effectiveness of the web filtering by preventing users from evading the security
implementation. Organizations can use its multiple integrated technologies including proxy site URL, proxy
application control, and IPS proxy behavior blocking.

User and Device Awareness

Most networks in today’s organizations are connected with both corporate and personal mobile devices. User and
device awareness provides the option to configure intelligent policies that can effectively enforce security.

To tackle the prevalence of BYOD environments, administrators are able to configure web content access policies
with sources defined by IPs, users, and devices, either combined or selectively.

External URL Filtering support

In instances where customers have large, existing, deployed implementations of a specific URL filtering solution
but replace their legacy firewalls with a FortiGate family, they can still retain their web filtering infrastructure since
FortiOS supports both ICAP and WISP.
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Monitoring, Logging, and Reporting

FortiOS empowers an organization to implement security best practices that require continuous monitoring of
threats, allowing the organization to adapt to new requirements.

The FortiView dashboards display useful analysis data with detailed and contextual session information, which
can be filtered and ranked, with drilldown options also available. This information, including system events
activities and administration audit trails, can also be archived via logs.

FortiOS logs all the types of traffic that can connect to or terminate at the FortiGate unit. In turn, these logs can
generate useful trending and overview reports.
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The FortiGate line combines a number of security features to protect your network from threats. As a whole,
these features, when included in a single Fortinet security appliance, are referred to as Security Profiles.

This overview addresses the following topics:

l Traffic inspection
l Content inspection and filtering
l Security Profiles components
l Security Profiles/lists/sensors

Firewall policies limit access, and while this and similar features are a vital part of securing your network, they are
not covered in this discussion of Security Profiles.

FortiOS 5.4 no longer supports FortiClient 5.0.

FortiOS 5.4.1 supports only FortiClient 5.4.1. Be sure to upgrade managed
FortiClients before upgrading the FortiGate to 5.4.1.

FortiOS 5.2 can support FortiClient 5.0, but only if the FortiGate upgraded to FortiOS
5.2. Customers need to purchase a FortiClient 5.4 subscription-based FortiClient
license.

Traffic inspection
When the FortiGate unit examines network traffic one packet at a time for IPS signatures, it is performing traffic
analysis. This is unlike content analysis where the traffic is buffered until files, email messages, web pages, and
other files are assembled and examined as a whole.

DoS policies use traffic analysis by keeping track of the type and quantity of packets, as well as their source and
destination addresses.

Application control uses traffic analysis to determine which application generated the packet.

Although traffic inspection doesn’t involve taking packets and assembling files they are carrying, the packets
themselves can be split into fragments as they pass from network to network. These fragments are reassembled
by the FortiGate unit before examination.

No two networks are the same and few recommendations apply to all networks. This topic offers suggestions on
how you can use the FortiGate unit to help secure your network against content threats.

IPS signatures

IPS signatures can detect malicious network traffic. For example, the Code Red worm attacked a vulnerability in
the Microsoft IIS web server. Your FortiGate’s IPS system can detect traffic attempting to exploit this
vulnerability. IPSmay also detect when infected systems communicate with servers to receive instructions.
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IPS recommendations

l Enable IPS scanning at the network edge for all services.
l Use FortiClient endpoint IPS scanning for protection against threats that get into your network.
l Subscribe to FortiGuard IPS Updates and configure your FortiGate unit to receive push updates. This will ensure

you receive new IPS signatures as soon as they are available.
l Your FortiGate unit includes IPS signatures written to protect specific software titles from DoS attacks. Enable the

signatures for the software you have installed and set the signature action to Block.
l You can view these signatures by going to Security Profiles > Intrusion Prevention and selecting the [View
IPS Signatures] link in the right-hand corner of the window.

l Because it is critical to guard against attacks on services that you make available to the public, configure IPS
signatures to block matching signatures. For example, if you have a web server, configure the action of web server
signatures to Block.

Suspicious traffic attributes

Network traffic itself can be used as an attack vector or a means to probe a network before an attack. For
example, SYN and FIN flags should never appear together in the same TCP packet. The SYN flag is used to
initiate a TCP session while the FIN flag indicates the end of data transmission at the end of a TCP session.

The FortiGate unit has IPS signatures that recognize abnormal and suspicious traffic attributes. The SYN/FIN
combination is one of the suspicious flag combinations detected in TCP traffic by the TCP.BAD.FLAGS
signature.

The signatures that are created specifically to examine traffic options and settings, begin with the name of the
traffic type they are associated with. For example, signatures created to examine TCP traffic have signature
names starting with TCP.

Application control

While applications can often be blocked by the ports they use, application control allows convenient management
of all supported applications, including those that do not use set ports.

Application control recommendations

l Some applications behave in an unusual manner in regards to application control. For more information, see
Application considerations on page 2864.

l By default, application control allows the applications not specified in the application control list. For high security
networks, you may want to change this behavior so that only the explicitly allowed applications are permitted.

SSL/SSH inspection

Regular web filtering can be circumvented by using https:// instead of http://. By enabling this feature, the
FortiGate can filter traffic that is using the HTTPS protocol. This sort of analysis is some times referred to as deep
scanning.

Deep Inspection works along the following lines: If your FortiGate unit has the correct chipset it will be able to
scan SSL encrypted traffic in the same way that regular traffic can be scanned. The FortiGate firewall will
essentially receive the traffic on behalf of the client and open up the encrypted traffic. Once it is finished it re-
encrypts the traffic and sends it on to its intended recipient. It is very similar to a man-in-the-middle attack. By
enabling this feature, it allows the FortiGate firewall to filter on traffic that is using the SSL encrypted protocol.

The encrypted protocols that can be inspected are:
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l HTTPS
l SMTPS
l POP3S
l IMAPS
l FTPS

Before the invention of SSL inspection, scanning regular web traffic can be circumvented by using the prefix
https:// instead of http:// in the URL. SSL inspection prevents this circumvention. However, because when the
encrypted traffic is decrypted it has to be re-encrypted with the FortiGate’s certificate rather than the original
certificate it can cause errors because the name on the certificate does not match the name on the web site.

At one point deep inspection was something that was either turned on or off. Now individual deep inspection
profiles can be created depending on the requirements of the policy. Depending on the Inspection Profile, you
can:

l Configure which CA certificate will be used to decrypt the SSL encrypted traffic.
l Configure which SSL protocols will be inspected.
l Configure which ports will be associated with which SSL protocols for the purpose of inspection.
l Configure which websites will be exempt from SSL inspection
l Configure whether or not to allow invalid SSL certificates.
l Configure whether or not SSH traffic will be inspected.

Web Rating Overrides

This feature allows you to override the FortiGuard Web Filtering. This option allows users to change the rating for
a website and control access to the site without affecting the rest of the sites in the original category. More
information can be found in Overriding FortiGuard website categorization.

Web Profile Overrides

This feature allows administrators to grant temporary access to sites that are otherwise blocked by a web filter
profile. The temporary access can be granted to a user, user group, or source IP address. The time limit can be
set in days, hours, or minutes. See the section on Web Profile Overrides for more information.

Content inspection and filtering
When the FortiGate unit buffers the packets containing files, email messages, web pages, and other similar files
for reassembly before examining them, it is performing content inspection. Traffic inspection, on the other hand,
is accomplished by the FortiGate unit examining individual packets of network traffic as they are received.

No two networks are the same and few recommendations apply to all networks. This topic offers suggestions on
how you can use the FortiGate unit to help secure your network against threats to content. Be sure to understand
the effects of the changes before using the suggestions.

AntiVirus

The FortiGate antivirus scanner can detect viruses and other malicious payloads used to infect machines. The
FortiGate unit performs deep content inspection. To prevent attempts to disguise viruses, the antivirus scanner
will reassemble fragmented files and uncompress content that has been compressed. Patented Compact Pattern
Recognition Language (CPRL) allows further inspection for common patterns, increasing detection rates of virus
variations in the future.
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AntiVirus recommendations

l Enable antivirus scanning at the network edge for all services.
l Use FortiClient endpoint antivirus scanning for protection against threats that get into your network.
l Subscribe to FortiGuard AntiVirus Updates and configure your FortiGate unit to receive push updates. This will

ensure that new antivirus signatures are loaded onto your FortiGate as soon as they are available.
l Enable the Extended Virus Database if your FortiGate unit supports it.
l Examine antivirus logs periodically. Take particular notice of repeated detections. For example, repeated virus

detection in SMTP traffic could indicate a system on your network is infected and is attempting to contact other
systems to spread the infection using a mass mailer.

l To conserve system resources, avoid scanning email messages twice. Scan messages as they enter and leave your
network or when clients send and retrieve them, rather than both.

l Enable Treat Windows Executables in Email Attachments as Viruses if you are concerned about incoming
'.exe' files.

FortiGuard Web Filtering

The web is the most popular part of the Internet and, as a consequence, virtually every computer connected to
the Internet is able to communicate using port 80, HTTP. Botnet communications take advantage of this open
port and use it to communicate with infected computers. FortiGuard Web Filtering can help stop infections from
malware sites and help prevent communication if an infection occurs.

FortiGuard Web Filtering recommendations

l Enable FortiGuard Web Filtering at the network edge.
l Install the FortiClient application and use FortiGuard Web Filtering on any systems that bypass your FortiGate unit.
l Block categories such as Pornography, Malware, Spyware, and Phishing. These categories are more likely to be

dangerous.
l In the Anti-Spam profile, enable Spam Detection and Filtering and then enable IP Address Check. Many IP

addresses used in spam messages lead to malicious sites; checking them will protect your users and your network.

DNS Filter

DNS-based web filtering

This feature is similar to the FortiGuard DNSweb filtering available in FortiOS 5.2. You can configure DNSweb
filtering to allow, block, or monitor access to web content according to FortiGuard categories. When DNSweb
filtering is enabled, your FortiGate must use the FortiGuard DNS service for DNS lookups. DNS lookup requests
sent to the FortiGuard DNS service return with an IP address and a domain rating that includes the FortiGuard
category of the web page.

If that FortiGuard category is set to block, the result of the DNS lookup is not returned to the requester. If the
category is set to redirect, then the address returned to the requester points at a FortiGuard redirect page.

You can also allow access or monitor access based on FortiGuard category.

The following filtering options can be configured in a DNS Filter security profile:
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Blocking DNS requests to known Botnet C&C addresses

A new FortiGuard database contains a list of known Botnet C&C addresses. This database is updated
dynamically and stored on the FortiGate. This database is covered by FortiGuard web filter licensing; you must
have an active FortiGuard web filtering license to use this feature. You can view the botnet lists by going to
System > FortiGuard > Botnet IPs and System > FortiGuard > Botnet Domains.

When you block DNS requests to known Botnet C&C addresses, using IPS, DNS lookups are checked against the
Botnet C&C database. All matching DNS lookups are blocked. Matching uses a reverse prefix match, so all sub-
domains are also blocked.

To enable blocking of DNS requests to known Botnet C&C addresses, go to Security Profiles > DNS Filter,
and enable Block DNS requests to known botnet C&C. When you do this in FortiOS 5.4.1, you can open a
definitions window by clicking on "botnet package."

Static URL filter

The DNS static URL filter allows you to block, exempt, or monitor DNS requests by using IPS to look inside DNS
packets and match the domain being looked up with the domains on the static URL filter list. If there is a match
the DNS request can be blocked, exempted, monitored, or allowed.

If blocked, the DNS request is blocked and so the user cannot look up the address and connect to the site.

If exempted, access to the site is allowed even if another method is used to block it.

Anti-Spam

Spam is a common means by which attacks are delivered. Users often open email attachments they should not,
and infect their own machine. The FortiGate email filter can detect harmful spam and mark it, alerting the user to
the potential danger.

Anti-Spam filter recommendations

l Subscribe to the FortiGuard Anti-Spam Filtering service.
l Enable email filtering at the network edge for all types of email traffic.
l Use FortiClient endpoint scanning for protection against threats that get into your network.

Data Leak Prevention

Most security features on the FortiGate unit are designed to keep unwanted traffic out of your network while Data
Leak Prevention (DLP) can help you keep sensitive information from leaving your network. For example, credit
card numbers and social security numbers can be detected by DLP sensors.

DLP recommendations

l Rules related to HTTP posts can be created, but if the requirement is to block all HTTP posts, a better solution is to
use application control or the HTTP POST Action option in the web filter profile.

l While DLP can detect sensitive data, it is more efficient to block unnecessary communication channels than to use
DLP to examine it. If you don’t use instant messaging or peer-to-peer communication in your organization, for
example, use application control to block them entirely.
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Security Profiles components
Below is a brief description of the security profiles and their features.

AntiVirus

Your FortiGate unit stores a virus signature database that can identify more than 15,000 individual viruses.
FortiGate models that support additional virus databases are able to identify hundreds of thousands of viruses.
With a FortiGuard AntiVirus subscription, the signature databases are updated whenever a new threat is
discovered.

AntiVirus also includes file filtering. When you specify files by type or by file name, the FortiGate unit will block
the matching files from reaching your users.

FortiGate units with a hard drive or configured to use a FortiAnalyzer unit can store infected and blocked files for
that you can examine later.

Web Filter

Web filtering includes a number of features you can use to protect or limit your users’ activity on the web.

FortiGuard Web Filtering is a subscription service that allows you to limit access to web sites. More than 60
million web sites and two billion web pages are rated by category. You can choose to allow or block each of the 77
categories.

URL filtering can block your network users from access to URLs that you specify.

Web content filtering can restrict access to web pages based on words and phrases appearing on the web page
itself. You can build lists of words and phrases, each with a score. When a web content list is selected in a web
filter profile, you can specify a threshold. If a user attempts to load a web page and the score of the words on the
page exceeds the threshold, the web page is blocked.

DNS Filter

The FortiGate will inspect DNS traffic to any DNS server, so long as the policy has DNS inspection enabled. The
FortiGate will intercept DNS requests, regardless of the destination IP, and redirect it to the FortiGuard Secure
DNS server -- this is separate from the FortiGuard DNS server.

The Secure DNS server will resolve and rate the FQDN and send a DNS response which includes both IP and
rating of the FQDN back to the FortiGate, where it will handle the DNS response according to the DNS filter
profile.

Application Control

Although you can block the use of some applications by blocking the ports they use for communications, many
applications do not use standard ports to communicate. Application control can detect the network traffic of more
than 1,000 applications, improving your control over application communication.

Cloud Access Security Inspection (CASI)

This feature introduced in FortiOS 5.4 is now merged with Application Control. See the "Cloud Access Security
Inspection (CASI)" on page 2860 discussion under Application Control for more information on this feature.
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Intrusion Protection

The FortiGate Intrusion Protection System (IPS) protects your network against hacking and other attempts to
exploit vulnerabilities of your systems. More than 3,000 signatures are able to detect exploits against various
operating systems, host types, protocols, and applications. These exploits can be stopped before they reach your
internal network.

You can also write custom signatures tailored to your network.

Anti-Spam

FortiGuard Anti-Spam is a subscription service that includes an IP address black list, a URL black list, and an
email checksum database. These resources are updated whenever new spam messages are received, so you do
not need to maintain any lists or databases to ensure accurate spam detection.

You can use your own IP address lists and email address lists to allow or deny addresses, based on your own
needs and circumstances.

Data Leak Prevention

Data Leak Prevention (DLP) allows you to define the format of sensitive data. The FortiGate unit can then
monitor network traffic and stop sensitive information from leaving your network. Rules for U.S. social security
numbers, Canadian social insurance numbers, as well as Visa, Mastercard, and American Express card numbers
are included.

VoIP

The Session Initiation Protocol (SIP) is an IETF application layer signaling protocol used for establishing,
conducting, and terminating multi-user multimedia sessions over TCP/IP networks using any media. SIP is often
used for Voice over IP (VoIP) calls but can be used for establishing streaming communication between end
points.

For more information, see VoIP Solutions: SIP.

ICAP

This module allows for the offloading of certain processes to a separate server so that your FortiGate firewall can
optimize its resources and maintain the best level of performance possible.

FortiClient Profiles

FortiClient is an all-in-one comprehensive endpoint security solution that extends the power of Fortinet’s
Advanced Threat Protection (ATP) to end user devices. As the endpoint is the ultimate destination for malware
that is seeking credentials, network access, and sensitive information, ensuring that your endpoint security
combines strong prevention with detection and mitigation is critical.

The FortiGate provides network security by defining compliance rules for FortiClient endpoints.

Proxy Options

Proxy Options includes features you can configure for when your FortiGate is operating in proxy mode, including
protocol port mapping, block oversized files/emails, and other web and email options.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2785

https://docs.fortinet.com/document/fortigate/5.6.0/voip-solutions-sip


Inspection Modes

SSL/SSH Inspection

SSL/SSH Inspection (otherwise known as Deep Inspection) is used to scan HTTPS traffic in the same way that
HTTP traffic can be scanned. This allows the FortiGate to receive and open up the encrypted traffic on behalf of
the client, then the traffic is re-encrypted and sent on to its intended destination.

Individual Deep Inspection profiles can be created, depending on the requirements of the policy. Depending on
the profile, you can:

l Configure which CA certificate will be used to decrypt the SSL encrypted traffic
l Configure which SSL protocols will be inspected
l Configure which ports will be associated with which SSL protocols for inspection
l Configure whether or not to allow invalid SSL certificates
l Configure whether or not SSH traffic will be inspected

Security Profiles/lists/sensors
A profile is a group of settings that you can apply to one or more firewall policies. Each Security Profile feature is
enabled and configured in a profile, list, or sensor. These are then selected in a security policy and the settings
apply to all traffic matching the policy. For example, if you create an antivirus profile that enables antivirus
scanning of HTTP traffic, and select the antivirus profile in the security policy that allows your users to access the
World Wide Web, all of their web browsing traffic will be scanned for viruses.

While you can apply more than one security profile to a firewall policy, it is not
recommended that you use flow-based profiles and proxy-based profiles in the same
firewall policy.

Because you can use profiles in more than one security policy, you can configure one profile for the traffic types
handled by a set of firewall policies requiring identical protection levels and types, rather than repeatedly
configuring those same profile settings for each individual security policy.

For example, while traffic between trusted and untrusted networks might need strict protection, traffic between
trusted internal addresses might need moderate protection. To provide the different levels of protection, you
might configure two separate sets of profiles: one for traffic between trusted networks, and one for traffic
between trusted and untrusted networks.

Inspection Modes

You can select one of two inspection modes from the System > Settings page to control the security profile
inspection mode for your FortiGate or VDOM.

l Proxy-based inspection, that reconstructs content passing through the FortiGate unit and inspects the content for
security threats, or

l Flow-based inspection, that takes a snapshot of content packets and uses pattern matching to identify security
threats in the content.

Each inspection component plays a role in the processing of traffic en route to its destination. Having control over
flow and proxy mode is helpful if you want to be sure that only flow inspection mode is used (and that proxy
inspection mode is not used). In most cases proxy mode is preferred because more security profile features are
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available and more configuration options for these individual features are available. Yet, some implementations
may require all security profile scanning to only use flow mode. In this case, you can set your FortiGate to flow
mode knowing that proxy mode inspection will not be used. While both modes offer significant security, proxy-
based provides more features and flow-based is designed to optimize performance.

This section addresses the following topics:

Proxy-based inspection
If a FortiGate or VDOM is configured for proxy-based inspection, then a mixture of flow-based and proxy-based
inspection occurs. Traffic initially encounters the IPS engine, which applies single-pass IPS, Application Control,
and CASI, if configured in the firewall policy accepting the traffic.

The traffic is then sent for proxy-based inspection. Proxy-based inspection extracts and caches content, such as
files and web pages, from a content session and inspects the cached content for threats. Content inspection
takes place in the following order: VoIP inspection, DLP, AntiSpam,Web Filtering, AntiVirus, and ICAP.

If no threat is found, the proxy relays the content to its destination. If a threat is found, the proxy can block the
threat and send a replacement message in its stead. The proxy can also block VoIP traffic that contains threats.

Flow-based inspection
Flow-based inspection identifies and blocks security threats in real time as they are identified using single-pass
Direct Filter Approach (DFA) pattern matching to identify possible attacks or threats.

If a FortiGate or a VDOM is configured for flow-based inspection, depending on the options selected in the
firewall policy that accepted the session, flow-based inspection can apply IPS, Application Control,Web
Filtering, DLP, and AntiVirus. Flow-based inspection is all done by the IPS engine and, as you would expect,
no proxying is involved.

All of the applicable flow-based security modules are applied simultaneously in one single pass, and pattern
matching is offloaded and accelerated by CP8 or CP9 processors. IPS, Application Control, flow-basedWeb
Filtering, and flow-based DLP filtering happen together. Flow-based AntiVirus scanning caches files during
protocol decoding and submits cached files for virus scanning while the other matching is carried out.

Flow-based inspection typically requires fewer processing resources than proxy-based inspection and does not
change packets, unless a threat is found and packets are blocked. Flow-based inspection cannot apply as many
features as proxy inspection. For example, flow-based inspection does not support client comforting and some
aspects of replacement messages.

In FortiOS 5.6, flow-based inspection requires the new NGFWmode.

Changing between proxy and flowmode
You can see which inspection mode your FortiGate is using by looking at the System Information widget on
yourDashboard.

To change inspection modes, go to System > Settings and scroll down to Inspection Mode. You can select
Flow-based to operate in Flow mode or Proxy to operate in Proxy mode.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2787



Inspection Modes

When you select Flow-based, all proxy mode profiles are converted to flow mode, removing any proxy settings.
As well proxy mode only features (for example, Web Application Profile) are removed from the GUI.

In addition, selecting Flow-based inspection will cause the Explicit Web Proxy and Explicit FTP Proxy
features to be removed from the GUI and the CLI. This includes Explicit Proxy firewall policies.

W hen you select Flow-based you can only configure Virtual Servers (under Policy & Objects > Virtual
Servers) with Type set to HTTP, TCP, UDP, or IP.

If required, you can change back to proxy mode through the System > Settings page.

If your FortiGate has multiple VDOMs, you can set the inspection mode independently for each VDOM. Use the
top left drop-down menu to go toGlobal > System > VDOM. ClickEditfor the VDOM you wish to change and
select the Inspection Mode.

Switching to flow-based inspection also turns off WAN Optimization, Web Caching,
the Explicit Web Proxy, and the Explicit FTP Proxy making sure that no proxying can
occur.

From the GUI, you can only configure antivirus and web filter security profiles in proxy mode. From the CLI you
can configure flow-based antivirus profiles, web filter profiles and DLP profiles and they will appear on the GUI
and include their inspection mode setting. Also, flow-based profiles created when in flow mode are still available
when you switch to proxy mode.

NGFW profile-based and NGFW policy-based modes

When you select Flow-based as the Inspection Mode, you have the option in FortiOS 5.6 to select an NGFW
Mode. NGFW Profile-basedmode works the same as flow-based mode did in FortiOS 5.4

When selecting NGFW policy-based mode you can also select the SSL/SSH Inspection mode that is applied to all
policies.

In the newNGFW Policy-basedmode, you add applications and web filtering profiles directly to a policy without
having to first create and configure Application Control or Web Filtering profiles. See NGFW Policy Mode
(397035) on page 96.

When you change to flow-based inspection, all proxy mode profiles are converted to flow mode, removing any
proxy settings. And proxy-mode only features (for example, Web Application Profile) are removed from the GUI.

If your FortiGate has multiple VDOMs, you can set the inspection mode independently for each VDOM. Go to
System > VDOM. ClickEdit for the VDOM you wish to change and select the Inspection Mode.

CLI syntax

The following CLI commands can be used to configure inspection and NGFW (called "policy" in the CLI) modes:

config system settings
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set inspection-mode {proxy | flow}
set policy-mode {standard | ngfw}

end

Comparison of inspection types
The tables in this section show how different security features map to different inspection types and present the
strengths and weaknesses of proxy- vs. flow-based inspection.

Security profile features mapped to inspection mode

The table below lists FortiOS security profile features and shows whether they are available in flow-based or
proxy-based inspection modes.

Security Profile Feature Flow-based inspection Proxy-based inspection

AntiVirus x x

Web Filter x x

DNS Filter x x

Application Control x x

Intrusion Protection x x

Anti-Spam x

Data Leak Protection x

VoIP x

ICAP x

Web Application Firewall x

FortiClient Profiles x x

Proxy Options x x

SSL Inspection x x

SSH Inspection x

Web Rating Overrides x x

Web Profile Overrides x
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Individual Security Profile considerations
In flow mode, AntiVirus and Web Filter profiles only include flow-mode features. Web filtering and virus scanning
are still done with the same engines and to the same accuracy, but some inspection options are limited or not
available in flow mode. Application control, intrusion protection, and FortiClient profiles are not affected when
switching between flow and proxy mode.

Application control uses flow-based inspection; if you apply an additional security profile to your traffic that is
proxy-based, the connection will simply timeout rather than display the warning, or replacement, message.
However, Application Control will still function.

Even though VoIP profiles are not available from the GUI in flow mode, the FortiGate can process VoIP traffic. In
this case the appropriate session helper is used (for example, the SIP session helper).

Setting flow or proxy mode doesn't change the settings available from the CLI. However, when in flow mode you
can't save security profiles that are set to proxy mode.

You can also add proxy-only security profiles to firewall policies from the CLI. So, for example, you can add a
VoIP profile to a security policy that accepts VoIP traffic. This practice isn't recommended because the setting will
not be visible from the GUI.

If you set flow-based to use external servers for FortiWeb and FortiMail you must use the CLI to set a Web
Application Firewall profile or Anti-Spam profile to external mode and add the Web Application Firewall profile or
AntiSpam profile to a firewall policy.

Proxy mode and flowmode antivirus and web filter profile options
The following tables list the antivirus and web filter profile options available in proxy and flow modes.

Antivirus features in proxy and flow mode

Feature Proxy Flow

Scan Mode (Quick or Full) no yes

Detect viruses (Block or Monitor) yes yes

Inspected protocols yes no (all relevant protocols are
inspected)

Inspection Options yes yes (not available for quick scan
mode)

Treat Windows Executables in Email Attachments as
Viruses

yes yes

Send Files to FortiSandbox Appliance for Inspection yes yes

Use FortiSandbox Database yes yes

Include Mobile Malware Protection yes yes
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Web Filter features in proxy and flow mode

Feature Proxy Flow

FortiGuard category based filter yes yes (show, allow, monitor,
block)

Category Usage Quota yes no

Allow users to override blocked categories (on some models) yes no

Search Engines yes no

Enforce 'Safe Search' on Google, Yahoo!,
Bing, Yandex

yes no

Restrict YouTube Access yes no

Log all search keywords yes no

Static URL Filter yes yes

Block invalid URLs yes no

URL Filter yes yes

Block malicious URLs discovered by
FortiSandbox

yes yes

Web Content Filter yes yes

Rating Options yes yes

Allow websites when a rating error occurs yes yes

Rate URLs by domain and IP Address yes yes

Block HTTP redirects by rating yes no

Rate images by URL yes no

Proxy Options yes no
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Feature Proxy Flow

Restrict Google account usage to specific
domains

yes no

Provide details for blocked HTTP 4xx and 5xx
errors yes no

HTTP POST Action yes no

Remove Java Applets yes no

Remove ActiveX yes no

Remove Cookies yes no

Filter Per-User Black/White List yes no

AntiVirus Scanning differences between versions of FortiOS 5.x

In FortiOS 5.0, 5.2, 5.4, and 5.6, there are several AntiVirus (AV) scanning inspection modes available. FortiOS
5.0 includes proxy and flow-based virus scanning. FortiOS 5.2 also uses proxy-based and flow-based scanning,
but the flow-based mode in FortiOS 5.2 uses a new approach to flow-based scanning (that is sometimes called
deepflow or deep flow scanning). FortiOS 5.4 and 5.6 offer another flow-based mode, quick mode, to inspect
traffic efficiently.

The databases used for AV scanning does not change from proxy to flow mode unless quick mode is enabled. In
flow-based quick mode, a compact antivirus database is used.

AntiVirus scanning examines files in HTTP, HTTPS, email, and FTP traffic for threats as they pass through your
FortiGate. If the traffic contains compressed files, they are also examined. Go to the SysAdmin Note on the
Fortinet Cookbook site for detailed information on supported compression formats in antivirus scanning.

If the AV scanner finds a threat such as a virus or some other malware, FortiOS protects your network by blocking
the file.

FortiOS includes a number of AntiVirus features that make virus scanning more user-friendly. One of these
features, called replacement messages, sends a customizable message to anyone whose file is blocked by AV
scanning, to explain what happened and why. Other features make communication between the client and the
server more seamless. The availability of these changes depending on the inspection mode.

Proxy-based AV scanning

Proxy-based AV scanning is the most feature-rich AV scanning mode.  This mode uses a proxy to manage the
communication between client and server. The proxy extracts content packets from the data stream as they arrive
and buffers the content until the complete file is assembled. Once the file is whole, the AV scanner examines the
file for threats. If no threats are found, the file is sent to its destination. If a threat is found, the file is blocked.

Because proxy-based scanning is applied to complete files, including compressed files, it provides very effective
threat detection. Proxy-based scanning also supports a full range of features, including replacement messages
and client comforting, making proxy-based scanning the most user friendly inspection mode. In addition the proxy
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manages the communication between the client and the server, improving the user experience. For example, in
flow mode if a virus is found, the last part of the file is not downloaded and the connection just times out and the
user cannot tell what is going on. In proxy mode, the users gets a message about the file being blocked.

Proxy-based scanning inspects all files under the oversized threshold. Since the FortiGate unit has a limited
amount of memory, files larger than a certain size do not fit within the memory buffer. The default buffer size is
10 MB. You can use the uncompsizelimitCLI command to adjust the size of this memory buffer. Files larger
than the threshold are passed to the destination without scanning. You can use theOversized File/Email
setting in Security Profiles > Proxy Options to block files larger than the antivirus buffer if allowing files that
are too large to be scanned is an unacceptable security risk.

During the buffering and scanning procedure, the client must wait. With a default configuration, the file is
released to the client only after it is scanned. You can enable client comforting in the Proxy Options security
profile to feed the client a trickle of data to prevent them from possibly thinking the transfer is stalled and
consequently canceling the download.

Flow-based AV scanning

Although the name "flow-based scanning" is used in FortiOS 5.0, 5.2, 5.4, and 5.6, the different versions handle
this mode in very different ways.

Flow AV in FortiOS 5.4 and 5.6

In FortiOS 5.4 and 5.6, there are two modes available for flow-based virus scanning: Quick and Full scan mode.
Full mode is the same as flow-based scanning in FortiOS 5.2 (see below). Quick mode uses a compact antivirus
database and advanced techniques to improve performance. You can designate quick or full scan mode when
configuring the antivirus profile in the GUI. Alternatively, use the following CLI command to enable quick or full
mode:

config antivirus profile
edit <profile>

set scan-mode {quick | full}
end

Flow AV in FortiOS 5.2 (deepflow or deep flow)

FortiOS 5.2 introduced a new type of flow-based AV scanning, that is sometimes called deepflow or deep flow,
and that takes a hybrid approach where content packets are buffered while simultaneously being sent to their
destination. When all of the files packets have been collected and buffered, but before the final packet is
delivered, the buffered file is scanned. If a threat is found, the last packet is blocked and the client application has
to deal with not getting the completed file. If no threat is found the final packet is sent and the user gets their file.

Deepflow AV scanning is as good as proxy-based AV scanning at detecting threats. There may be a small
performance advantage over proxy-based AV as files get larger based on the difference between sending the
whole file after analysis and just sending the last packet.  Deepflow's most notable limitation is that, just like the
flow-based AV in 5.0, it does not support many of the user-friendly features provided by proxy-based AV.

Flow AV in FortiOS 5.0

In FortiOS 5.0, flow-based AV scanning examines the content of individual data packets as they pass through the
FortiGate. There is no proxy involved so packets are not changed by the proxy and files are not buffered for
analysis. Potentially less memory and CPU resources are used, resulting in a potential performance increase
compared to using proxy-based mode. FortiOS 5.0 flow-based AV scanning is also not limited by file size.
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Flow AV uses the IPS engine and the AV database and is effective at many kinds of threat detection; however,
because it can only analyze what is in an individual packet rather than a complete file, flow-based scanning
cannot detect some types of malware, including polymorphic code. Malware in documents, compressed files, and
some archives are also less likely to be detected.

Flow AV does not actually block files, it stops delivering a file's packets once a threat has been detected. This
means that parts of the file may already have been delivered when the threat has been detected and the recipient
application is responsible for dealing with the partially complete content.

In addition flow AV can be less user friendly. Replacement messages are not supported and clients may have to
wait for sessions to time out without knowing why content has been blocked.
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This section describes how to configure the antivirus options. From an antivirus profile you can configure the
FortiGate unit to apply antivirus protection to HTTP, FTP, IMAP, POP3, SMTP, and NNTP sessions. If your
FortiGate unit supports SSL/SSH content scanning and inspection, you can also configure antivirus protection for
HTTPS, IMAPS, POP3S, SMTPS, and FTPS sessions.

In many cases you can just customize the default antivirus profile and apply it to the security policy that accepts
the traffic to be virus scanned. You can also create custom antivirus profiles if want to apply different types of
virus protection to different traffic.

This Handbook chapter includes Inside FortiOS: AntiVirus providing readers an overview of the features and
benefits of key FortiOS 5.6 components.

For readers needing to delve into greater detail, we provide the following topics:

l Antivirus concepts
l Enabling AntiVirus scanning
l Testing your antivirus configuration
l Example Scenarios

Antivirus concepts
The word “antivirus” refers to a group of features that are designed to prevent unwanted and potentially malicious
files from entering your network. These features all work in different ways, which include checking for a file size,
name, or type, or for the presence of a virus or grayware signature.

The antivirus scanning routines your FortiGate unit uses are designed to share access to the network traffic. This
way, each individual feature does not have to examine the network traffic as a separate operation, and the
overhead is reduced significantly. For example, if you enable file filtering and virus scanning, the resources used
to complete these tasks are only slightly greater than enabling virus scanning alone. Two features do not require
twice the resources.

Antivirus scanning examines files for viruses, worms, trojans, and other malware. The antivirus scan engine has a
database of virus signatures it uses to identify infections. If the scanner finds a signature in a file, it determines
that the file is infected and takes the appropriate action.

Malware threats

Malware is the general term covering all the different types of threats to your computer safety such as:

l Viruses
l Worms
l Trojan horses
l Ransomware
l Scareware
l Spyware
l Adware
l Botnets
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l Phishing
l Grayware

Viruses

Viruses are self-replicating code that install copies of themselves into other programs or data files for boot sectors
of storage devices. Viruses can often carry a “payload” which performs some undesirable function. These
functions can include but are not limited to:

l Stealing drive space
l Stealing CPU cycles
l Accessing private information
l Corrupting data
l Digital defacement or vandalism
l Spamming contact lists

Worms

Aworm is a piece of standalone computer code that replicates itself in order to spread to other computers. It
normally uses a computer network to spread itself, using security vulnerabilities on the target computer or
network to propagate. Unlike a virus, it does not attach itself to an existing file. Even if there is no payload, worms
consume resources such as bandwidth and storage space just through their act of replication.

Trojan horses

A Trojan horse, or Trojan is malware that is defined by its delivery method. Through the use of social engineering,
or some other method, the code is installed on a system by a valid user of the system and like the original Trojan
horse there is something more than advertised within the software. Trojans, unlike worms or viruses are generally
non-self-replicating. The most common payload of a Trojan is the setting up of a “backdoor” control mechanism
to the system that it is installed on.

Ransomware

Ransomware is a type of malware that, as the name implies, hold the system ransom until payment of some kind
is made. It does this by restricting access to the legitimate owner of the system either by encrypting files or
locking the system. Usually, a message of some kind is displayed with the demands. Upon payment a utility or
key is sent to the user to unlock the system.

Scareware

Scareware comes in two main flavours; the first tries to convince the user that his computer is infected with some
non-existent malware, scaring the user into purchasing the author’s virus removal utility. The utility is
nonfunctional or some additional form of malware.

The second form tries to convince the user that the computer has been or is being used for an illegal act, such as
being part of a botnet or storing child pornography. Again, the objective is to scare the user into paying to cure
something that is not really there.
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Spyware

Spyware is used by its authors to collect information about the user and its computer without the user's
knowledge. The end result can be as benign as being better able to target ads, to as criminal as key loggers
designed to record account ids and passwords of bank accounts and forward them off to the authors.

Adware

Adware is not malware per se. It is merely any software that produces advertisements in order to generate
revenue for its author. While a lot of people find this inconvenient or irritating, it is not malware. As such, it is not
blocked by the antivirus software for being malware.

Software that has adware built into it will be blocked if it has malware in it.

Botnets

A botnet is a network of Internet connected computers that have been covertly usurped to forward transmissions
to other computers on the Internet on behalf of a “master”. These transmissions can be minimally damaging,
such as spam, or they can critically impact a target as when used to launch a Distributed Denial of Service attack.

Any such computer is referred to as a zombie - in effect, a computer "robot" or "bot" that serves the wishes of
some master spam or virus originator. Most computers compromised in this way are home-based.

According to a report from Russian-based Kaspersky Labs, botnets -- not spam, viruses, or worms -- currently
pose the biggest threat to the Internet. A report from Symantec came to a similar conclusion.

See also: Botnet protection.

Phishing

Phishing is a social engineering technique that is used to obtain sensitive and confidential information by
masquerading as a communication from a trusted entity such as a well-known institution, company, or website.
Usually, the malware is not in the communication itself but in the links within the communication.

Grayware

Grayware programs are unsolicited software programs installed on computers, often without the user’s consent or
knowledge. Grayware programs are generally considered an annoyance, but they can also cause system
performance problems or be used for malicious purposes.

AntiVirus scanning order

The antivirus scanning function includes various modules and engines that perform separate tasks.

FortiOS has two different modes of antivirus scanning: proxy-based and flow-based. The reasons for the
different modes are performance and granularity. In just about everything relating to security there is a constant
balancing act going on. As the level of security and comprehensiveness increases, there is by necessity a
decrease in either convenience or performance or both. The increase in processing to scan for more threats
requires more resources; resources that are a finite supply on the hardware. Granularity can sometimes be used
to mitigate performance impact by scanning for a smaller subset of traffic but this is only recommended when
that smaller subset of traffic is the only traffic going through the firewall.
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If the traffic on the device is slight, then the impact on the performance will hardly be noticeable. But if the unit is
working close to capacity in terms of traffic and there are a lot of files coming through, then there might be a
noticeable decline in the performance.

While both modes offer significant security, proxy-based is weighted towards being more thorough and easily
configurable, while flow-based is designed to optimize performance.

See Antivirus scanning differences in FortiOS 5.0, 5.2, 5.4, and 5.6 in the Inspection
Modes section for more details on flow vs. proxy inspection modes on your FortiGate.

Proxy-based antivirus scanning order

The following figure illustrates the antivirus scanning order when using proxy-based scanning. The first check for
oversized files/email is to determine whether the file exceeds the configured size threshold. The
uncompsizelimit check is to determine if the file can be buffered for file type and antivirus scanning. If the
file is too large for the buffer, it is allowed to pass without being scanned. For more information, see the config
antivirus service command. The antivirus scan includes scanning for viruses, as well as for grayware and
heuristics, if enabled.

File filtering includes file pattern and file type scans which are applied at different
stages in the antivirus process.
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Antivirus scanning order when using the normal, extended, or extreme database

If a file fails any of the tasks of the antivirus scan, no further scans are performed. For example, if the file
fakefile.EXE is recognized as a blocked file pattern, the FortiGate unit will send the end user a replacement
message, and delete or quarantine the file. The unit will not perform virus scan, grayware, heuristics, and file type
scans because the previous checks have already determined that the file is a threat and have dealt with it.

Flow-based antivirus scanning order

The following figure illustrates the antivirus scanning order when using flow-based scanning (i.e. the flow-based
database). The antivirus scan takes place before any other antivirus-related scan. If file filter is not enabled, the
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file is not buffered. The antivirus scan includes scanning for viruses, as well as for grayware and heuristics if they
are enabled.
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AntiVirus databases

The antivirus scanning engine relies on a database of virus signatures to detail the unique attributes of each
infection. The antivirus scan searches for these signatures, and when one is discovered, the FortiGate unit
determines the file is infected and takes action.

All FortiGate units have the normal antivirus signature database but some models have additional databases you
can select for use. Which you choose depends on your network and security needs.

Normal Includes viruses currently spreading as determined by the FortiGuard Global Security
Research Team. These viruses are the greatest threat. The Normal database is the
default selection and it is available on every FortiGate unit.

Extended
Includes the normal database in addition to recent viruses that are no-longer active.
These viruses may have been spreading within the last year but have since nearly or
completely disappeared.

Extreme Includes the extended database in addition to a large collection of ‘zoo’ viruses. These
are viruses that have not spread in a long time and are largely dormant today. Some
zoo viruses may rely on operating systems and hardware that are no longer widely
used.

If your FortiGate unit supports extended, extreme, or flow-based virus database definitions, you can select the
virus database most suited to your needs.

If you require the most comprehensive antivirus protection, enable the extended virus database. The additional
coverage comes at a cost, however, because the extra processing requires additional resources.

To change the antivirus database

Use the CLI to run the following commands:

config antivirus settings
set default-db extended

end

AntiVirus techniques

The first three antivirus features in the list below work in sequence to efficiently scan incoming files and offer your
network optimal antivirus protection. The first two features have specific functions, the third, heuristics, protects
against new or previously unknown virus threats.

l Virus scan
If the file passes the file pattern scan, the FortiGate unit applies a virus scan to it. The virus definitions are kept up-
to-date through the FortiGuard Distribution Network (FDN).

l Grayware protection

If the file passes the virus scan, it can be checked for grayware. Grayware scanning is an optional function and
must be enabled in the CLI if it is to be scanned for along with other malware. Grayware cannot be scanned for on
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its own. While done as a separate step, antivirus scanning must be enabled as well.

To enable grayware detection enter the following in the CLI:

config antivirus settings
set grayware enable

end

To disable grayware detection enter the following in the CLI:

config antivirus settings
set grayware disable

end

Grayware signatures are kept up to date in the same manner as the antivirus definitions.

l Heuristics
After an incoming file has passed the grayware scan, it is subjected to the heuristics scan. The FortiGate heuristic
antivirus engine, if enabled, performs tests on the file to detect virus-like behavior or known virus indicators. In this
way, heuristic scanning may detect new viruses, but may also produce some false positive results. You configure
heuristics from the CLI.

To set heuristics, enter the following in the CLI:

config antivirus heuristic
set mode {pass | block |disable}

end

l “block” enables heuristics and any files determined to be malware are blocked from entering the network.
l “pass” enables heuristics but any files determined to be malware are still allowed to pass through to the recipient.
l “disable” turns off heuristics.

l FortiGuard AntiVirus
The FortiGuard Antivirus services are included in the regular FortiGuard subscription and include automatic
updates of antivirus engines and definitions as well as a DNS black list (DNSBL) through the FortiGuard
Distribution Network (FDN).

Current information about your subscription and version numbers can be found at System > FortiGuard. This
page will also allow the configuration of connections to the FortiGuard Center and how often to check for updates
to the antivirus files.

Updating antivirus definitions can cause a short disruption of traffic being scanned
while the FortiGate unit applies the new signature database. Schedule updates for time
periods when traffic is light to minimize disruption.

l Botnet protection
A botnet is a network of Internet connected computers that have been covertly usurped to forward transmissions to
other computers on the Internet on behalf of a “master”. These transmissions can be minimally damaging, such as
spam, or they can critically impact a target as when used to launch a Distributed Denial of Service attack.

Any such computer is referred to as a zombie - in effect, a computer "robot" or "bot" that serves the wishes of some
master spam or virus originator. Most computers compromised in this way are home-based.
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The latest botnet database is available from FortiGuard. To see the version of the database and display its
contents, go to System > FortiGuard > AntiVirus > and you will see data forBotnet IPs and Botnet
Domains. You can also block, monitor, or allow outgoing connections to botnet sites for each FortiGate interface.

l Quarantine / Source IP ban
As of FortiOS 5.2, quarantine was a place where traffic content was held in storage where it couldn’t interact with
the network or system. This was removed, but the term quarantine was kept to describe keeping selected source
IPs from interacting with the network and protected systems. This source IP ban is kept in the kernel rather than in
any specific application engine and can be queried by APIs. The features that can use the APIs to access and use
the banned source IP addresses are antivirus, DLP, DoS and IPS. Both IPv4 and IPv6 version are included in this
feature.

You quarantine a source address through the GUI. Go to FortiView > Sources. Right-click on the source address
you wish to quarantine and select Quarantine Source Address. You can set the duration of the quarantine in
days, hours, minutes, or seconds. A User Quarantine ban can be removed inMonitor > User Quarantine
Monitor.

To configure the AntiVirus security profile to add the source IP address of an infected file to the quarantine or list of
banned source IP addresses in the CLI:

config antivirus profile
edit <name of profile>

config nac-quar
set infected quar-src-ip
set expiry 5m

end

If the quar-src-ip action is used, the additional variable of expiry time will become available. This variable
determines for how long the source IP adddress will be blocked. In the CLI the option is called expiry and the
duration is in the format <###d##h##m>. The maximum days value is 364. The maximum hour value is 23 and
the maximum minute value is 59. The default is 5 minutes.

FortiGuard AntiVirus updates

To ensure that your system receives the most protection available, all virus definitions and signatures are
updated regularly through the FortiGuard AntiVirus services. To configure this feature, go to System
> FortiGuard. UnderAntiVirus & IPS Updates, enable Scheduled Updates. From here you can schedule
updates to occur on a consistent weekly, daily, or even hourly basis.

Updating antivirus definitions can cause a short disruption of traffic being scanned
while the FortiGate unit applies the new signature database. Schedule updates for
time periods when traffic is light to minimize disruption.

FortiSandbox

Not every piece of malware has a signature. This is especially true of new malware and variations on existing
malware. FortiOS can upload suspicious files to FortiSandbox for sandbox inspection. When a FortiGate uses
sandbox inspection, files are sent to the FortiSandbox. Then the FortiSandbox uses virtual machines (VMs)
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running different operating systems to test the file, to determine if it is malicious. If the file exhibits risky behavior,
or is found to contain a virus, a new signature can be added to both the local FortiGate malware database and the
FortiGuard AntiVirus signature database.

A file is deemed suspicious when it does not contain a known threat but has characteristics that suggest it may be
malware. The characteristics that determine if a file is suspicious are updated by Fortinet to reflect the current
threat climate.

FortiSandbox is available as a physical or virtual appliance (FortiSandbox Appliance), or as a cloud advanced
threat protection service integrated with FortiGate (FortiCloud).

To configure an AntiVirus profile to send files to FortiSandbox, first verify that your FortiSandbox appliance is
configured or that your FortiCloud account is active. Then go to Security Profiles > AntiVirus and enter the
desired Inspection Options.

Sending files to the FortiSandbox appliance or to FortiSandbox Cloud does not block files immediately. Instead,
the files assist in the discovery of new threats and the creation of new signatures to be added to the global
FortiGuard AntiVirus database. Files deemed malicious are also immediately added to a custom Malware
Package which is downloaded by the FortiGate every two minutes for live detection.

The Advanced Threat Protection Statistics dashboard widget displays the number of files that your FortiGate
unit has uploaded or submitted to FortiSandbox. To see FortiSandbox statistics for the last 7 days, go to Fortinet
Security Fabric> Settings.

Client Comforting

When proxy-based antivirus scanning is enabled, the FortiGate unit buffers files as they are downloaded. Once
the entire file is captured, the FortiGate unit scans it. If no infection is found, the file is sent along to the client.
The client initiates the file transfer and nothing happens until the FortiGate finds the file clean, and releases it.
Users can be impatient, and if the file is large or the download slow, they may cancel the download, not realizing
that the transfer is in progress.

The client comforting feature solves this problem by allowing a trickle of data to flow to the client so they can see
the file is being transferred. The default client comforting transfer rate sends one byte of data to the client every
ten seconds. This slow transfer continues while the FortiGate unit buffers the file and scans it. If the file is
infection-free, it is released and the client will receive the remainder of the transfer at full speed. If the file is
infected, the FortiGate unit caches the URL and drops the connection. The client does not receive any
notification of what happened because the download to the client had already started. Instead, the download
stops and the user is left with a partially downloaded file.

If the user tries to download the same file again within a short period of time, the cached URL is matched and the
download is blocked. The client receives the Infection cache message replacement message as a notification
that the download has been blocked. The number of URLs in the cache is limited by the size of the cache.

Client comforting can send unscanned and potentially infected content to the client.
You should only enable client comforting if you are prepared to accept this risk.
Keeping the client comforting interval high and the amount low will reduce the amount
of potentially infected data that is downloaded.

Client comforting is available for HTTP and FTP traffic. If your FortiGate unit supports SSL content scanning and
inspection, you can also configure client comforting for HTTPS and FTPS traffic.
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Enable and configure client comforting

1. Go to Security Profiles > Proxy Options.
2. Select a Proxy Options profile and choose Edit, or select Create New to make a new one.
3. Scroll down to the Common Options section and enable the Comfort Clients feature. This will set the option

on all of the applicable protocols. The ability to set this feature on a protocol by protocol basis exists in the CLI.
4. Select OK or Apply to save the changes.
5. Apply this Proxy Options profile in any security policy for it to take effect on all traffic handled by the policy.
The default values for Interval and Amount are 10 and 1, respectively. This means that when client comforting
takes effect, 1 byte of the file is sent to the client every 10 seconds. You can change these values to vary the
amount and frequency of the data transferred by client comforting.

Oversized files and emails

Downloaded files can range from a few Kilobytes to multiple Gigabytes. A FortiGate doesn’t have the memory to
allow for a large number of people downloading large files. Imagine the memory required for a team of
developers to all download the latest Linux OS distribution at once, in addition to the normal requirements of the
firewall. Everything would come to a grinding halt if the FortiGate tried to store each of those Gigabyte+ files in
memory. To give you some piece of mind, the chances of malware being in a large file like those is much smaller
than in a smaller single Megabyte file, so the threat is somewhat limited, but you will probably want to use your
computers antivirus software to scan those large files after they have been downloaded.

A threshold must be set to prevent the resources of the system from becoming overloaded. By default the
threshold is 10 MB. Any files larger than the threshold will not be scanned for malware. With a maximum file size
threshold in place, it must now be determined what is to be done with the files that are larger than threshold.
There are only 2 choices; either the file is passed through without being scanned for malware or the file is
blocked. The default action for oversized files is to pass them through.

If you wish to block the downloading of files over the threshold, this can be set within the Proxy Option profile
found at Security Profiles > Proxy Options, underCommon Options.

Enable Block Oversized File/Email.

This will reveal an additional option, Threshold (MB). The threshold of the files is set based upon the protocol
being used to transfer the file. In the CLI and configuration file, the threshold variable is found in each of the
protocol sections within the profile. Changing the value in this field will change the oversize-limit value for
all of the protocols.

If you wish to change the oversize-limit value on the protocols covered in a Proxy Option profile you have
two options.

1. You can go into the CLI and change the value manually within each of the protocol sections.
2. You can use the GUI to temporarily block oversized files, and when configuring it change the threshold to the new

value that you want. Apply this setting. Then go back to the profile and turn off the block setting. If you now go into
the CLI you will find that the configuration file has retained the new oversize-limit value.

The settings can be found in the CLI by going to:

config firewall profile-protocol-options
edit <profile_name>

config <protocol>
set oversize-limit <size_int>

end
end

end
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Archive scan depth

The antivirus scanner will open archives and scan the files inside. Archives within other archives, or nested
archives, are also scanned to a default depth of twelve nestings. You can adjust the number of nested archives
the FortiGate unit will scan with the uncompressed-nest-limit CLI command. Further, the limit is
configured separately for each traffic type.

Configuring archive scan depth

For example, this CLI command sets the archive scan depth for SMTP traffic to 5. That is, archives within
archives will be scanned five levels deep.

config firewall profile-protocol-options
edit "default"

config http
set uncompressed-nest-limit 5

end
end

end

You can set the nesting limit from 2 to 100.

Scan buffer size

When checking files for viruses, there is a maximum file size that can be buffered. Files larger than this size are
passed without scanning. The default size for all FortiGate models is 10 megabytes.

Archived files are extracted and email attachments are decoded before the FortiGate unit determines if they can
fit in the scan buffer. For example, a 7 megabyte ZIP file containing a 12 megabyte EXE file will be passed
without scanning with the default buffer size. Although the archive would fit within the buffer, the uncompressed
file size will not.

Configuring the uncompression buffer

In this example, the uncompressed-oversize-limit CLI command is used to change the scan buffer size
to 20 megabytes for files found in HTTP traffic:

config firewall profile-protocol-options
edit <profile_name>

config http
set uncompressed-oversize-limit 20

end
end

end

The maximum buffer size varies by model. Enter set uncompressed-oversize-limit ? to display the
buffer size range for your FortiGate unit.

Windows file sharing (CIFS)

FortiOS supports virus scanning of Windows file sharing traffic. This includes CIFS, SMB, and SAMBA traffic.
This feature is applied by enabling SMB scanning in an antivirus profile and then adding this profile to a security
policy that accepts CIFS traffic. CIFS virus scanning is available only through flow-based antivirus scanning.
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FortiOS flow-based virus scanning can detect the same number of viruses in CIFS/SMB/SAMBA traffic as it can
for all supported content protocols.

Note the following about CIFS/SMB/SAMBA virus scanning:

l Some newer version of SAMBA clients and SMB2 can spread one file across multiple sessions, preventing some
viruses from being detected if this occurs.

l Enabling CIFS/SMB/SAMBA virus scanning can affect FortiGate performance.
l SMB2 is a new version of SMB that was first partially implemented in Windows Vista.
l Currently SMB2 is supported byWindows Vista or later, and partly supported by Samba 3.5 and fully support by

Samba 3.6.
l The latest version of SMB2.2 will be introduced with Windows 8.
l Most clients still use SMB as default setting.

Configuring CIFS/SMB/SAMBA virus scanning

Use the following command to enable CIFS/SMB/SAMBA virus scanning in an antivirus profile:

config antivirus profile
edit <smb-profile>

config smb
set options scan

end

Then add this antivirus profile to a security policy that accepts the traffic to be virus scanned. In the security policy
the service can be set to ALL, SAMBA, or SMB.

config firewall policy
edit <policy-id-integer>

set service ALL
...
set utm-status enable
set av-profile <smb-profile>

end

Enabling AntiVirus scanning
Antivirus scanning is configured in an AntiVirus profile, but it is enabled in a firewall policy. Once the use of an
AntiVirus profile is enabled and selected in one or more firewall policies, all the traffic controlled by those firewall
policies will be scanned according to the settings in that profile.

By going to System > Feature Visibility, you can enable or disable two aspects of the AntiVirus Profile.

1. AntiViruswill determine if the option to use AntiVirus profiles is available.
2. Multiple Security Profileswill determine if you can configure any AntiVirus profiles beyond the default profile.

The enabling or disabling of a feature in Feature Visibility refers to its visibility within the GUI, not whether or
not the feature’s will work. Disabling the AntiVirus Profile feature removes it from the GUI but it can still be
accessed and configured in CLI. Since the functionality of the FortiGate unit is based on the contents of the
config file any profile referred to by the policy in the configuration will be acted upon. The Feature
Visibilitysection is primarily for keeping the GUI clean and uncluttered by features that are not being used by the
administrators.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2807



AntiVirus

The use of antivirus protection is a minimum standard for security protection. The question left to decide is
whether or not you wish to use multiple profiles in your configuration.

AntiVirus profiles

From Security Profiles > AntiVirus you can edit existing profiles or create and configure new antivirus profiles
that can then be applied to firewall policies. A profile is specific configuration information that defines how the
traffic within a firewall policy is examined and what action may be taken based on the examination.

The configuration of the antivirus profile depends on whether the inspection mode is proxy-based or flow-based.
You select the inspection mode by going to the System > Settings page. The FortiGate's inspection mode is
also displayed on the unit'sDashboard in the System Information widget.

The discussion of the differences in antivirus scanning modes helps to understand how this scanning works in
proxy- and flow-based inspection, as well as in different versions of FortiOS 5.x.

Enabling AntiVirus in Proxy-mode - GUI

1. Go to Security Profiles > AntiVirus.
2. Choose whether you want to edit an existing profile or create a new one.

l The default profile will be the one displayed by default.
l If you are going to edit an existing profile, selecting it can be done by either using the drop down menu in the

upper right hand corner of the window or by selecting the List icon (the furthest right of the 3 icons in the upper
right of the window, if resembles a page with some lines on it), and then selecting the profile you want to edit
from the list.

l If you need to create a new profile you can either select the Create New icon (a plus sign within a circle) or
select the List icon and then select the Create New link in the upper left of the window that appears.

3. If you are creating a new profile, write a name for it in the Name field.
4. For the Detect Viruses field, select eitherBlock to prevent infected files from passing throughout the FortiGate

orMonitor to allow infected files to pass through the FortiGate but to record instances of infection.
5. Under Inspected Protocols, enable the protocols you wish to be blocked or monitored.
6. Under Inspection Options, you may enable the following: Treat Windows Executables in Email

Attachments as Viruses and Include Mobile Malware Protection.

You may also enable the following options if you have a FortiCloud account active on
your FortiGate: Send Files to FortiSandbox Cloud for Inspection and Use
FortiSandbox Database.

7. Select OK orApply.
8. Add the AntiVirus profile to a firewall security policy.
To view Mobile Malware license and version information, go to System > FortiGuard and locate the Mobile
Malware section in the License Information table.

Enabling AntiVirus in Flow-mode - GUI

1. Go to Security Profiles > AntiVirus.
2. Choose whether you want to edit an existing profile or create a new one.
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l The default profile will be the one displayed by default.
l If you are going to edit an existing profile, selecting it can be done by either using the drop down menu in the

upper right hand corner of the window or by selecting the List icon (the furthest right of the 3 icons in the upper
right of the window, if resembles a page with some lines on it), and then selecting the profile you want to edit
from the list.

l If you need to create a new profile you can either select the Create New icon (a plus sign within a circle) or
select the List icon and then select the Create New link in the upper left of the window that appears.

3. If you are creating a new profile, write a name for it in the Name field.
4. Select Quick or Full Scan Mode(see the discussion of the differences in antivirus scanning modes for more

information).
5. For the Detect Viruses field, select eitherBlock to prevent infected files from passing throughout the FortiGate

orMonitor to allow infected files to pass through the FortiGate but to record instances of infection.
6. Under Inspected Protocols, enable the protocols you wish to be blocked or monitored.
7. Under Inspection Options, you may enable the following: Treat Windows Executables in Email

Attachments as Viruses and Include Mobile Malware Protection.

You may also enable the following options if you have a FortiCloud account active on
your FortiGate: Send Files to FortiSandbox Cloud for Inspection and Use
FortiSandbox Database.

8. Select OK orApply.
9. Add the AntiVirus profile to a firewall security policy.

Enabling AntiVirus - CLI

Configure the scan option for each type of traffic you want scanned.

1. Configure the AntiVirus profile
config antivirus profile

edit <profile_name>
set comment "scan and delete virus"
set replacemsg-group ''
set scan-botnet-connections block
set ftgd-analytics suspicious
config http

set options scan
end
config ftp

set options scan
end
config imap

set options scan
end
config pop3

set options scan
end
config smtp

set options scan
end
config nntp

set options scan
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end
config smb

set options scan
end

end

2. Add the AntiVirus profile to the Fortigate firewall security policy. When using the CLI, you will need to know the
policy ID number.

config firewall policy
edit <policy ID number>

set av-profile <profile_name>
set profile-protocol-options default

end
end

Testing your antivirus configuration
You have configured your FortiGate unit to stop viruses, but you’d like to confirm your settings are correct. Even if
you have a real virus, it would be dangerous to use for this purpose. An incorrect configuration will allow the virus
to infect your network.

To solve this problem, the European Institute of Computer Anti-virus Research has developed a test file that
allows you to test your antivirus configuration. The EICAR test file is not a virus. It cannot infect computers, nor
can it spread or cause any damage. It’s a very small file that contains a sequence of characters. Your FortiGate
unit recognizes the EICAR test file as a virus so you can safely test your FortiGate unit antivirus configuration.

Go to http://www.fortiguard.com/antivirus/eicartest.html to download the test file (eicar.com) or the test file in a
ZIP archive (eicar.zip).

If the antivirus profile applied to the security policy that allows you access to the Web is configured to scan HTTP
traffic for viruses, any attempt to download the test file will be blocked. This indicates that you are protected.

Example scenarios
The following examples provide sample antivirus configuration scenarios.

Configuring simple default AntiVirus profile

If performance is not a real concern and the FortiGate’s resources are not being stretched, it is perfectly
reasonable to create one AntiVirus profile that covers the range of uses found in your environment. This example
is one possible default configuration.

Context:

l This is an edited default profile and will be used on all security policies
l It will need to scan for malware on all available protocols.
l Malware, botnets, and grayware should be blocked
l The inspection method should be flow-based
l A current FortiCloud account is available
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Creating the profile - GUI

1. In the following fields, enter the settings shown in the screenshot.
2. Select Apply.
3. Enable grayware scanning through the CLI.

config antivirus settings
set grayware enable

end

Creating the profile - CLI

1. Enter the CLI by one of the following methods:
l SSH through a terminal emulator
l CLI Console access
l FortiExplorer’s CLI mode

2. Enter the following commands:
config antivirus profile

edit default
set comment "scan and delete virus"
set inspection-mode flow-based
set scan-botnet-connections block
set ftgd-analytics suspicious
config http

set options scan
end

config ftp
set options scan
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end
config imap

set options scan
end

config pop3
set options scan
end

config smtp
set options scan
end

config nntp
set options scan
end

config smb
set options scan
end

end

3. Enable grayware scanning
config antivirus settings

set grayware enable
end

Setting up a basic proxy-based AntiVirus profile for email traffic

Small offices, whether they are small companies, home offices, or satellite offices, often have very simple needs.
This example details how to enable antivirus protection on a FortiGate unit located in a satellite office.

Context:

l The satellite office does not have an internal email server. To send and retrieve email, the employees connect to an
external mail server.

l There is a specific firewall security profile that handles the email traffic from the Internet to the mail server. The only
traffic on this policy will be POP3 and IMAP and SMTP

l The company policy is to block viruses and connections to botnets.
l The FortiGate unit is a small model and the Internet bandwidth is limited so the policy is to not submit files to the

FortiSandbox.

Creating the profile - GUI

1. In the following fields, enter the indicated values or selections:

Name email-av

Comments Scans email traffic from Internet for malware

Inspection Mode Proxy

Detect Virus Block

Send Files to FortiSandbox
for Inspection

checked
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•   Suspicious Files Only checked

Detect Connections to
Botnet C&C Servers

checked

•   Block checked

2. Check the appropriate protocols:

Inspected Protocols Virus Scan and Block

HTTP checked

SMTP checked

POP3 checked

IMAP checked

MAPI checked

FTP checked

NNTP checked

3. Select Apply.

Creating the profile - CLI

1. Enter the CLI by one of the following methods:
l SSH through a terminal emulator
l CLI Console widget
l FortiExplorer’s CLI mode

2. Enter the following commands:
Config antivirus profile

edit "email-av"
set comment "Scans email traffic from Internet for malware"
set inspection-mode proxy
config imap

set options scan
end

config pop3
set options scan
end

config smtp
set options scan
end

end

Adding the profile to a policy

In this scenario the following assumptions will be made:
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l The policy that the profile is going to be added to is an IPv4 policy.
l The ID number of the policy is 11.
l The AntiVirus profile being added will be the "default" profile
l The SSL/SSH Inspection profile used will be the "default" profile

FortiClient enforcement has been moved from the Policy page to Network
> Interfaces to enforce FortiClient registration on a desired LAN interface rather than
a policy.

Adding the profile - GUI

1. Go to Policy & Objects > IPv4 Policy.
2. Use your preferred method of finding a policy.

l If the ID column is available you can use that.
l You can also choose based on your knowledge of the parameters of the policy
l Select the policy with ID value of 11

3. In the Edit Policy window, go to the Security Profiles section
4. Turn ON AntiVirus, and in the drop down menu for the field, select default
5. If the AntiVirus profile is proxy-based the Proxy Options field and drop down menu will be revealed.
6. The SSL/SSH Inspection field will automatically be set to ON and one of the profiles will need to be selected from

the drop down menu. In this case default is selected.
7. The log options will depend on your requirements and resources but to verify that everything is working properly, it

is a good idea to turn ON logging of All Sessions after setting up a new profile and after giving some time for logs
to accumulate

8. Turn on Antivirus.
9. Select an antivirus profile.
10. Select OK to save the security policy.

Adding the profile - CLI

To select the antivirus profile in a security policy— CLI

config firewall policy
edit 11

set utm-status enable
set profile-protocol-options default
set av-profile basic_antivirus

end

Block files larger than 8 MB

Set proxy options profile to block files larger than 8 MB

1. Go to Security Profiles > Proxy Options.
2. Edit the default or select Create New to add a new one.
3. Scroll down to the common Options Section and place a check in the box next to BlockOversized File/Email
4. The sub line Threshold (MB) will appear with a value field. Enter 8.
5. Select OK orApply.
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The proxy options profile is configured, but to block files, you must select it in the firewall policies handling the
traffic that contains the files you want blocked.

To select the Proxy Options profile in a security policy

1. Go to Policy & Objects > IPv4 Policy (or IPv6 Policy, depending).
2. Edit or create a security policy.
3. Select a proxy-based security profile. You will know that there is a proxy component to the Security Profile because

when a Security Profile is Proxy based the Proxy Options field will be visible (for example, select an Antivirus
profile that includes proxy scanning).

4. Beside Proxy Options select the name of the MTU proxy options protocol.
5. Select OK to save the security policy.
6. Once you complete these steps, any files in the traffic subject to Security Profile scanning handled by this policy

that are larger than 8MBwill be blocked. If you have multiple firewall policies, examine each to determine if you
want to apply similar file blocking the them as well.
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This section describes FortiGate web filtering for HTTP traffic. The three main parts of the web filtering function,
the Web Content Filter, the URL Filter, and the FortiGuard Web Filtering Service interact with each other to
provide maximum control over what users on your network can view as well as protection to your network from
many Internet content threats. Web Content Filter blocks web pages containing words or patterns that you
specify. URL filtering uses URLs and URL patterns to block or exempt web pages from specific sources.
FortiGuard Web Filtering provides many additional categories you can use to filter web traffic.

This Handbook chapter includes Inside FortiOS: Web Filtering and provides readers an overview of the features
and benefits of key FortiOS 5.6 components.

For further detail than the Inside FortiOS document, we provide the following topics:

Web filter concepts
Web filtering is a means of controlling the content that an Internet user is able to view. With the popularity of web
applications, the need to monitor and control web access is becoming a key component of secure content
management systems that employ antivirus, web filtering, and messaging security. Important reasons for
controlling web content include:

l lost productivity because employees are accessing the web for non-business reasons
l network congestion — when valuable bandwidth is used for non-business purposes, legitimate business

applications suffer
l loss or exposure of confidential information through chat sites, non-approved email systems, instant messaging,

and peer-to-peer file sharing
l increased exposure to web-based threats as employees surf non-business-related web sites
l legal liability when employees access/download inappropriate and offensive material
l copyright infringement caused by employees downloading and/or distributing copyrighted material.

As the number and severity of threats increase on the World Wide Web, the risk potential increases within a
company's network as well. Casual non-business related web surfing has caused many businesses countless
hours of legal litigation as hostile environments have been created by employees who download and view
offensive content. Web-based attacks and threats are also becoming increasingly sophisticated. Threats and
web-based applications that cause additional problems for corporations include:

l spyware/grayware
l phishing
l pharming
l instant messaging
l peer-to-peer file sharing
l streaming media
l blended network attacks.

Spyware, also known as grayware, is a type of computer program that attaches itself to a user’s operating
system. It does this without the user’s consent or knowledge. It usually ends up on a computer because of
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something the user does such as clicking on a button in a pop-up window. Spyware can track the user’s Internet
usage, cause unwanted pop-up windows, and even direct the user to a host web site. For further information, visit
the FortiGuard Center.

Some of the most common types of grayware infection occur when:

l downloading shareware, freeware, or other forms of file-sharing services
l clicking on pop-up advertising
l visiting legitimate web sites infected with grayware.

Phishing is the term used to describe attacks that use web technology to trick users into revealing personal or
financial information. Phishing attacks use web sites and email that claim to be from legitimate financial
institutions to trick the viewer into believing that they are legitimate. Although phishing is initiated by spam email,
getting the user to access the attacker’s web site is always the next step.

Pharming is a next generation threat that is designed to identify and extract financial, and other key pieces of
information for identity theft. Pharming is much more dangerous than phishing because it is designed to be
completely hidden from the end user. Unlike phishing attacks that send out spam email requiring the user to click
to a fraudulent URL, pharming attacks require no action from the user outside of their regular web surfing
activities. Pharming attacks succeed by redirecting users from legitimate web sites to similar fraudulent web sites
that have been created to look and feel like the authentic web site.

Instant messaging presents a number of problems. Instant messaging can be used to infect computers with
spyware and viruses. Phishing attacks can be made using instant messaging. There is also a danger that
employees may use instant messaging to release sensitive information to an outsider.

Peer-to-peer (P2P) networks are used for file sharing. Such files may contain viruses. Peer-to-peer applications
take up valuable network resources and may lower employee productivity but also have legal implications with the
downloading of copyrighted or sensitive company material.

Streaming media is a method of delivering multimedia, usually in the form of audio or video to Internet users.
Viewing streaming media impacts legitimate business by using valuable bandwidth.

Blended network threats are rising and the sophistication of network threats is increasing with each new attack.
Attackers learn from each successful attack and enhance and update their attack code to become more
dangerous and to spread faster. Blended attacks use a combination of methods to spread and cause damage.
Using virus or network worm techniques combined with known system vulnerabilities, blended threats can quickly
spread through email, web sites, and Trojan applications. Examples of blended threats include Nimda, Code
Red, Slammer, and Blaster. Blended attacks can be designed to perform different types of attacks, which include
disrupting network services, destroying or stealing information, and installing stealthy backdoor applications to
grant remote access.

Different ways of controlling access

The methods available for monitoring and controlling Internet access range from manual and educational
methods to fully automated systems designed to scan, inspect, rate and control web activity.

Common web access control mechanisms include:

l establishing and implementing a well-written usage policy in the organization on proper Internet, email, and
computer conduct

l installing monitoring tools that record and report on Internet usage
l implementing policy-based tools that capture, rate, and block URLs.

The following information shows how the filters interact and how to use them to your advantage.
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Order of web filtering

The FortiGate unit applies web filters in a specific order:

1. URL filter
2. FortiGuard Web Filter
3. web content filter
4. web script filter
5. antivirus scanning.
If you have blocked a FortiGuard Web Filter category but want certain users to have access to URLs within that
pattern, you can use theOverridewithin the FortiGuard Web Filter. This will allow you to specify which users
have access to which blocked URLs and how long they have that access. For example, if you want a user to be
able to access www.example.com for one hour, you can use the override to set up the exemption. Any user listed
in an override must fill out an online authentication form that is presented when they try to access a blocked URL
before the FortiGate unit will grant access to it.

If you have blocked a FortiGuard Web Filter category but want users within a specific Web Filter profile to have
access to URLs within that pattern, you can use the following CLI command below to override (this will have no
timeout affiliated to it):

CLI Syntax:

config webfilter profile
edit <profile>

config web
set whitelist exempt-av exempt-dlp exempt-rangeblock extended-log-others
end

end

This command will set a Web Filter profile that exempts AV, DLP, RangeBlock, and supports extended log by
FortiGuard whitelist.

Inspection Modes
This topic briefly discusses proxy and flow-based inspection modes. For more information on flow vs. proxy
inspection modes on your FortiGate and how they impact web filtering, see Individual Security Profile
considerations in the Inspection Modes section.

Proxy

Proxy-based inspection involves buffering traffic and examining it as a whole before determining an action. The
process of having the whole of the data to analyze allows for the examination of more points of data than the
flow-based or DNSmethods.

The advantage of a proxy-based method is that the inspection can be more thorough than the other methods,
yielding fewer false positive or negative results in the data analysis.

Flow-based

The flow-based inspection method examines the file as it passes through the FortiGate unit without any
buffering. As each packet of the traffic arrives it is processed and forwarded without waiting for the complete file
or web page.
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The advantage of the flow-based method is that the user sees a faster response time for HTTP requests and
there is less chance of a time-out error due to the server at the other end responding slowly.

The disadvantages of this method are: (1) there is a higher probability of a false positive or negative in the
analysis of the data; and, (2) a number of security features that can be used in the proxy-based method are not
available in the flow-based inspection method. There are also fewer actions available based on the categorization
of the website by FortiGuard services.

In flow mode, Web Filter profiles only include flow-mode features. Web filtering is still done with the same
engines and to the same accuracy, but some inspection options are limited or not available in flow mode.

Configuring Web Filter profiles in flow-mode is different depending on the NGFWmode selected.

See "What's new in FortiOS 5.6" on page 2750 and Individual Security Profile
Considerations in the Inspection Modes section for more details on flow vs. proxy
inspection modes on your FortiGate.

FortiGuard Web Filtering Service
FortiGuard Web Filtering is a managed web filtering solution available by subscription from Fortinet. Before you
begin to use the FortiGuard Web Filtering options, verify that you have a valid subscription to the service for your
FortiGate firewall.

FortiGuard Web Filtering enhances the web filtering features supplied with your FortiGate unit by sorting billions
of web pages into a wide range of categories users can allow or block. The FortiGate unit accesses the nearest
FortiGuard Web Filtering Service Point to determine the category of a requested web page, and then applies the
security policy configured for that user or interface. FortiGuard Web Filtering supports detection for traffic using
HTTP protocol (versions 1.0, 1.1, and 2.0).

FortiGuard Web Filtering includes over 45 million individual ratings of web sites that apply to more than two
billion pages. Pages are sorted and rated into several dozen categories administrators can allow or block.
Categories may be added or updated as the Internet evolves. To make configuration simpler, you can also
choose to allow or block entire groups of categories. Blocked pages are replaced with a message indicating that
the page is not accessible according to the Internet usage policy.

FortiGuard Web Filtering ratings are performed by a combination of proprietary methods including text analysis,
exploitation of the web structure, and human raters. Users can notify the FortiGuard Web Filtering Service Points
if they feel a web page is not categorized correctly, so that the service can update the categories in a timely
fashion.

FortiGuard Web Filtering and your FortiGate unit

When FortiGuard Web Filtering is enabled in a web filter or a DNS filter profile, the setting is applied to all firewall
policies that use this profile. When a request for a web page appears in traffic controlled by one of these firewall
policies, the URL is sent to the nearest FortiGuard server. The URL category is returned. If the category is
blocked, the FortiGate unit provides a replacement message in place of the requested page. If the category is not
blocked, the page request is sent to the requested URL as normal.

FortiGuard Web Filtering Actions

The possible actions are:
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l Allow permits access to the sites within the category.
l Block prevents access to sites within the category. Users attempting to access a blocked site will receive a

replacement message explaining that access to the site is blocked.
l Monitor permits and logs access to sites in the category. You may also enable user quotas when enabling the

monitor action.
l Warning presents the user with a message, allowing them to continue if they choose.
l Authenticate requires a user to authenticate with the FortiGate unit before being allowed access to the category or

category group.

The options of actions available will depend on the mode of inspection.

l Proxy - Allow, Block, Monitor, Warning, and Authenticate.
l Flow-based, policy-based - Allow, Deny.
l Flow-based, profile-based - Allow, Block, and Monitor.

Configuring Web Filter profiles in flow-mode is different depending on the
NGFWmode selected.
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Web Filtering flowchart
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FortiGuard Web Filtering categories

The following tables identify each FortiGuard web filtering category (organized by group) along with associated
category IDs. You can access the current list of category IDs through the CLI.

config webfilter profile
edit default

config ftgd-wf
config filters

edit 1
set category ?

For a complete description of each web filtering category, visit http://www.fortiguard.com/webfilter/categories.

Potentially Liable

ID Category ID Category

1 Drug Abuse 12 Extremist Groups

3 Hacking 59 Proxy Avoidance

4 Illegal or Unethical 62 Plagiarism

5 Discrimination 83 Child Abuse

6 Explicit Violence

Adult/Mature Content

ID Category ID Category

2 Alternative Beliefs 16 Weapons (Sales)

7 Abortion 57 Marijuana

8 Other Adult Materials 63 Sex Education

9 Advocacy Organizations 64 Alcohol

11 Gambling 65 Tobacco

13 Nudity and Risque 66 Lingerie and Swimsuit

14 Pornography 67 Sports Hunting and War Games

15 Dating
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Bandwidth Consuming

ID Category ID Category

19 Freeware and Software Downloads 72 Peer-to-peer File Sharing

24 File Sharing and Storage 75 Internet Radio and TV

25 Streaming Media and Download 76 Internet Telephony

Security Risk

ID Category ID Category

26 MaliciousWebsites 86 Spam URLs

61 Phishing 88 Dynamic DNS

Newly Observed Domain Newly Registered Domain

Newly observed domain (NOD) applies to URLs whose domain name is not rated and were observed for the first
time in the past 30 minutes.

Newly registered domain (NRD) applies to URLs whose domain name was registered in the previous 10 days.

General Interest - Personal

ID Category ID Category

17 Advertising 47 Travel

18 Brokerage and Trading 48 Personal Vehicles

20 Games 54 Dynamic Content

23 Web-based Email 55 Meaningless Content

28 Entertainment 58 Folklore

29 Arts and Culture 68 Web Chat

30 Education 69 Instant Messaging

33 Health and Wellness 70 Newsgroups and Message Boards

34 Job Search 71 Digital Postcards

35 Medicine 77 Child Education
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ID Category ID Category

36 News and Media 78 Real Estate

37 Social Networking 79 Restaurant and Dining

38 Political Organizations 80 Personal Websites and Blogs

39 Reference 82 Content Servers

40 Global Religion 85 Domain Parking

42 Shopping 87 Personal Privacy

44 Society and Lifestyles 89 Auction

46 Sports

General Interest - Business

ID Category ID Category

31 Finance and Banking 52 Information Technology

41 Search Engines and Portals 53 Armed Forces

43 General Organizations 56 Web Hosting

49 Business 81 Secure Websites

50 Information and Computer Security 84 Web-based Applications

51 Government and Legal Organizations

Local categories

Users can define custom or local categories. See Overriding FortiGuard Website Categorization for details.

FortiGuard Web Filtering usage quotas

In addition to using category and classification blocks and overrides to limit user access to URLs, you can set a
daily quota by category, category group, or classification. Quotas allow access for a specified length of time or a
specific bandwidth, calculated separately for each user. Quotas are reset every day at midnight.

Users must authenticate with the FortiGate unit. The quota is applied to each user individually so the FortiGate
must be able to identify each user. One way to do this is to configure a security policy using the identity-based
policy feature. Apply the web filter profile in which you have configured FortiGuard Web Filter and FortiGuard
Web Filter quotas to such a security policy.
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The use of FortiGuard Web Filtering quotas requires that users authenticate to gain
web access. The quotas are ignored if applied to a security policy in which user
authentication is not required.

Editing the web filter profile resets the quota timers for all users.

When a user first attempts to access a URL, they’re prompted to authenticate with the FortiGate unit. When they
provide their user name and password, the FortiGate unit recognizes them, determines their quota allowances,
and monitors their web use. The category and classification of each page they visit is checked and FortiGate unit
adjusts the user’s remaining available quota for the category or classification.

Quota hierarchy

You can apply quotas to categories and category groups. Only one quota per user can be active at any one time.
The one used depends on how you configure the FortiGuard Web Filter.

When a user visits a URL, the FortiGate unit queries the FortiGuard servers for the category of the URL. From
highest to lowest, the relative priority of the quotas are:

1. Category
2. Category group

Configuring Web Filter Profiles

Web Filter profile page GUI updates (309012)

The GUI for theWeb Filter security profile andWeb Profile Overrides pages are changed.

Web Filter profile page

l removed multilist for override user group and profile
l replaced FortiGuard categories actions icons with font icons
l added tooltip forAllow users to override blocked categories to explain the policy group dependency

Web Profile Overrides page

l removed multilist of user, user group, original profile, new profile
l duplicate profile for new profile (for bug #284239)

Enabling FortiGuard Web Filter

FortiGuard Web Filter is enabled and configured within web filter profiles by enabling FortiGuard Categories. The
service is engaged by turning on the Web Filter profile and selecting a profile that has FortiGuard Categories
enabled on one or more active policies being run by the firewall.

There is also a system wide setting for the enabling or disabling of FortiGuard Web Filter that is only in the CLI.

config system fortiguard
set webfilter-force-off

The two options on this setting are enable or disable. The syntax of the settings name is “force-off” so in order to
enable FortiGuard Webfilter you have to choose disable for the setting and enable if you want to turn it off.
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General configuration steps

1. Go to Security Profiles > Web Filter.
2. Determine if you wish to create a new profile, edit an existing one, or clone and edit an existing one.
3. If you are using FortiGuard Categories, enable the FortiGuard Categories, select the categories and select the

action to be performed.
4. Configure anyCategory Usage Quotas needed. (Proxy Mode)
5. Allow blocked override if required.(Proxy Mode)
6. Set up Safe Search settings and/or YouTube Education settings. (Proxy & Flow-based)
7. Configure Static URL Settings. (All Modes)
8. Configure Rating Options. (All Modes)
9. Configure Proxy Options.
10. Save the filter and web filter profile.
11. To complete the configuration, you need to select the security policy controlling the network traffic you want to

restrict. Then, in the security policy, enable Web Filter and select the appropriate web filter profile from the list.

Configuring FortiGuard Web Filter settings

FortiGuard Web Filter includes a number of settings that allow you to determine various aspects of the filtering
behavior.

Getting to the Edit Web Filter Profile configuration window

Once you have gotten to the profile configuration window there are a number of settings that can be used, most
of which are optional. We will treat each of these options separately, but present the common instructions of how
to get to the profile editing page here.

1. Go to Security Profiles > Web Filter.
2. Determine if you wish to create a new profile, edit an existing one, or clone and then edit an existing one.

a. New profile:

i. Select the Create New icon, in the upper right of the window (looks like a plus sign in a circle)OR
ii. Select the List icon, in the upper right (looks like a white rectangle with lines like text). Select the Create

New icon in the upper left.

b. Edit existing profile:

i. Select the name of the profile that you wish to edit from the drop-down menuOR
ii. Select the List icon, in the upper right (looks like a white rectangle with lines like text. Highlight the name

of the profile from the list and select Edit from the options above the list.

c. Clone a profile:

i. Select Clone icon in the upper right corner of the window (looks like one square overlapping another)OR
ii. Select the Listicon, in the upper right (looks like a white rectangle with lines like text. Highlight the name of

the profile from the list and select Clone from the options above the list.
3. Make sure there is a valid name, and comment if you want.
4. Configure the settings to best achieve your specific requirements
5. Select Apply orOK, depending on whether you are editing, creating, or cloning a profile.
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In older versions of FortiOS there was a character limitation for the URL of 2048 bytes
or approximately 321 characters. If the URL you were trying to reach was longer the
URL sent to FortiGuard would be truncated and the service would be unable to
categorize the site. Starting in version 5 of the firmware, the parsed URL has been
increase to 4 Kilobytes, effectively doubling the length of a URL capable of being
categorized.

To configure the FortiGuard Web Filter categories

1. Go to the Edit Web Filter Profilewindow.
2. The category groups are listed in a widget. You can expand each category group to view and configure every sub-

category individually within the groups. If you change the setting of a category group, all categories within the
group inherit the change.

3. Select the category groups and categories to which you want to apply an action.
To assign an action to a category left click on the category and select from the pop up menu.

4. Select Apply orOK.
Apply the web filter profile to an identity-based security policy. All the users subject to that policy are restricted by
the quotas.

If you look at your logs carefully, you may notice that not every URL connection in the
log shows a category. They are left blank. If you take one of those URL and enter it in
the FortiGuard website designed to show the category for a URL it will successfully
categorize it.

The reason for this is that to optimize speed throughput and reduce the load on the
FortiGuard servers the FortiGate does not determine a category rating on scripts and
css files.

Configuring FortiGuard Category Quotas

1. Go to the Edit Web Filter Profilewindow
2. Verify that the categories that need to have quotas on them are set to one of these actions:

l Monitor
l Warning
l Authenticate

3. UnderCategory Usage Quota, Select Create New or Edit
4. In the New/Edit Quotawindow that pops up, enable or disable the specific categories for that quota.
5. At the bottom of the widget, select a quota type and daily allowance for each user:

l Time -- can be entered in Hours, Minutes, or Seconds.
l Traffic -- can be entered in Bytes, KB, MB, orGB The value must be greater than 0.

6. Select Apply or OK.
7. Continue with any other configuration in the profile
8. Select Apply or OK.
Apply the web filter profile to an identity-based security policy. All the users subject to that policy are restricted by
the quotas.
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The use of FortiGuard Web Filtering quotas requires that users authenticate to gain
web access. The quotas are ignored if applied to a security policy in which user
authentication is not required.

Editing the web filter profile resets the quota timers for all users.

Configure Allowed Blocked Overrides

1. Go to the Edit Web Filter Profile window.
2. Enable Allow Blocked Override
3. In the Apply to Group(s) field select the desired User Group
4. In the Assign to Profile field, select the desired profile

Configure Search Engine Section

There are 2 primary configuration settings in this section.

Enable Safe Search

To enable the Safe Search settings

1. Go to the Edit Web Filter Profile window.
2. Enable Safe Search
3. Enable Search Engine Safe Search
4. Enable YouTube Filter

a. Enter the YouTube User ID in the Text field

Web Filter in flow mode does not support Safe Search

Log All Search Keywords

In the GUI, the configuration setting is limited to a checkbox.

Configure Static URL Filter

Web Content Filter

To enable the web content filter and set the content block threshold

1. Go to the Edit Web Filter Profile window.
2. In the Static URL Filter section enableWeb Content Filter.
3. Select Create New.
4. Select the Pattern Type.
5. Enter the content Pattern.
6. Enter the Language from the dropdown menu.
7. Select Block or Exempt, as required, from the Action list.
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8. Select Enable.
9. Select OK.

Configure Rating Options

Allow Websites When a Rating error Occurs

In the GUI, the configuration setting is limited to a checkbox.

Rate URLs by Domain and IP Address

In the GUI, the configuration setting is limited to a checkbox.

Block HTTP Redirects by Rating

In the GUI, the configuration setting is limited to a checkbox.

Rate Images by URL (Blocked images will be replaced with blanks)

In the GUI, the configuration setting is limited to a checkbox.

Configure Proxy Options

Restrict Google Account Usage to Specific Domains

Configuring the feature in the GIU

Go to Security Profiles > Web Filter.

In the Proxy Options section, check the box next to Restrict to Corporate Google Accounts Only.

Use the Create New link within the widget to add the appropriate Google domains that will be allowed.

Configuring the feature in the CLI

To configure this option in the CLI, the URL filter must refer to a web-proxy profile that is using the Modifying
HTTPRequest Headers feature. The command is only visible when the action for the entry in the URL filter is set
to either allow or monitor.

1. Configure the proxy options:
config web-proxy profile

edit "googleproxy"
config headers

edit 1
set name "X-GoogApps-Allowed-Domains"
set content "fortinet.com, Ladan.ca"
end

end
end

end

2. Set a web filter profile to use the proxy options
config webfilter urlfilter

edit 1
config entries

edit "*.google.com"
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set type wildcard
set action {allow | monitor}
set web-proxy-profile <profile>
end

end
end

end

In the CLI, you can also add, modify, and remove header fields in HTTP request when scanning web traffic in
proxy-mode. If a header field exists when your FortiGate receives the request, its content will be modified based
on the configurations in the URL filter.

Web Resume Download block

In the GUI, the configuration setting is limited to a checkbox.

Provide Details for Blocked HTTP 4xx and 5xx Errors

In the GUI, the configuration setting is limited to a checkbox.

HTTP POST Action

Remove Java Applet Filter

In the GUI, the configuration setting is limited to a checkbox.

Remove ActiveX Filter

In the GUI, the configuration setting is limited to a checkbox.

Remove Cookie Filter

In the GUI, the configuration setting is limited to a checkbox.

Overriding FortiGuard website categorization
In most things there is an exception to the rule. When it comes to the rules about who is allowed to go to which
websites in spite of the rules or in this case, policies, it seems that there are more exceptions than to most rules.
There are numerous valid reasons and scenarios for exceptions so it follows that there needs to be a way to
accommodate this exception.

The different methods of override

There are two different ways to override web filtering behavior based on FortiGuard categorization of a websites if
you are operating in proxy-based inspection.

The second method has two variations in implementation and each of the three has a different level of
granularity.

1. Using Alternate Categories
Web Rating Overrides

This method manually assigns a specific website to a different Fortinet category or a locally created
category.

2. Using Alternate Profiles
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Administrative Override or Allow users to override blocked categories

In this method all of the traffic going through the FortiGate unit, using identity based policies and a
Web Filtering profile has the option where configured users or IP addresses can use an alternative
Web Filter profile when attempting to access blocked websites.

CLI / flow

Using Alternate Categories

Web Rating Overrides

There are two approaches to overriding the FortiGuard Web Filtering. The first is an identity-based method that
can be configured using a combination of identity-based policies and specifically designed webfilter profiles. This
is addressed in the Firewall Handbook.

The second method is the system-wide approach that locally (on the FortiGate Firewall) reassigns a URL to a
different FortiGuard Category or even subcategory. This is where you can assign a specific URL to the FortiGuard
Category that you want to you can also set the URL to one of the Custom Categories that you have created

The Web Rating Overrides option is available because different people will have different criteria for how they
categorize websites. Even if the criteria is the same an organization may have reason to block the bulk of a
category but need to be able to access specific URLs that are assigned to that category.

A hypothetical example could be that a website, example.com is categorized as being in the Sub-Category
Pornography. The law offices of Barrister, Solicitor, and Lawyer do not want their employees looking at
pornography at work so they have used the FortiGuard Webfilter to block access to sites that have been assigned
to the Category “Pornography”. However, the owners of example.com are clients of the law office and they are
aware that example.com is for artists that specialize in nudes and erotic images. In this case two approaches can
be taken. The first is that the Web Rating Override function can be used to assign example.com to Nudity and
Risque instead of Pornography for the purposes of matching the criteria that the law office goes by or the site can
be assigned to a Custom Category that is not blocked because the site belongs to one of their clients and they
always want to be able to access the site.

Another hypothetical example from the other side of the coin. A private school has decided that a company that
specializes in the online selling of books that could be considered inappropriate for children because of their
violent subject matter, should not be accessible to anyone in the school. The categorization by Fortinet of the site
example2.com is General Interest - Business with the subcategory of Shopping and Auction, which is a category
that is allowed at the school. In this case they school could reassign the site to the Category Adult Material which
is a blocked category.

Local or Custom Categories

User-defined categories can be created to allow users to block groups of URLs on a per-profile basis. The
categories defined here appear in the global URL category list when configuring a web filter profile. Users can
rate URLs based on the local categories.

Users can create user-defined categories then specify the URLs that belong to the category. This allows users to
block groups of web sites on a per profile basis. The ratings are included in the global URL list with associated
categories and compared in the same way the URL block list is processed.

Local categories and local rating features consume a large amount of CPU resources;
use these features as little as possible.
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The local assignment of a category overrides the FortiGuard server ratings and appear in reports as “Local”
Categories or “Custom” Categories depending on the context.

CLI commands

In the CLI, the term is local category.

To create a local category:

config webfilter ftgd-local-cat
edit local_category_1

set id 140
end

To set a rating to a Local Category:

config webfilter ftgd-local-rating
edit <url_str>

set rating {[<category_int>] [group_str] . . .]
set status {enable | disable}

end

GUI commands

In the GUI Local Categories appears on the Edit Web Filter profile page and Custom Categories on the
Web Rating Overrides page, if your FortiGate is in proxy-based or flow-based, profile-based inspection. If your
FortiGate is operating with flow-based inspection and the policy-based NGFWmode, then you will not see the
Edit Web Filter profile page.

Both these features will be used to create local categories and to apply actions to them.

Creating a Local or Custom Category

1. Go to Security Profiles > Web Rating Overrides.
2. Select Custom Categories in the top menu bar.
3. In the new window, click on Create New.
4. Enter the name of the custom category.
5. Select OK.

Configuring Web Rating Overrides

Using the GUI

1. Go to Security Profiles > Web Rating Overrides.
2. Select Create New
3. Type in the URL field the URL of the Website that you wish to recategorize. Do not use wildcard expressions

when typing in the URL.
4. Select the Lookup Rating button to verify the current categorization assigned to the URL.
5. Change the Category field to one of the more applicable options from the drop down menu, for example, one of

the custom categories just created.
6. Change the Sub-Category field to a more narrowly defined option within the main category.
7. Select OK.
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It is usually recommended that you choose a category that you know will be addressed
in existing Web Filter profiles so that you will not need to engage in further
configuration.

Applying an Action to a Local or Custom Category

1. Go to Security Profiles > Web Filter.
2. Expand the Local Categories in the list of FortiGuard categories.
3. Right-click on a category from the list and set the action to Allow, Block, Monitor,Warning, Authenticate, or

Disable.
4. Select Apply.
You cannot apply an action to a local category when operating in flow-based NGFW policy-based mode.

Local Category scenarios

Scenario 1: The configuration of the domain name overrides the configuration for the subdirectory.

Depending on the URL specified or other aspects of configuration, the configuration of a local

or custom category may not take effect. Consider a scenario where you have defined:

l example.com – local rating as “category 1”, action set to Block
l example.com/subdirectory – local rating as “category 2”, action set to Monitor
l example.com/subdirectory/page.html – local rating as “category 3”, action set to Warning.

If a user browses to “example.com", access will be blocked. If a user browses to example.com/subdirectory,
access will also be blocked,even though that address was configured to be part of category2. The configuration of
the domain name overrides the configuration for the subdirectory.

However, if you configure a specific HTML page differently than the domain name, then that configuration will
apply. In this scenario, the user will see a Warning message but will be able to pass through to the page.

Scenario 2: User-defined local ratings and SNI matches

In this scenario, local categories are defined and sites are added to those categories.

l There is no behavioral difference if the hostname is sent from from ClientHello SNI or from HTTP request-url.
l The SNI will be used as hostname for https certificate-inspection or ssl-exempt.
l If a valid SNI exist, then SNI will be used as the domain name for url rating instead of CN inthe server certificate.
l For the local rating, "example.com" will match "test.example.com", but will not match "another_example.com".

Using Alternate Profiles

Allow Blocked Overrides or Web Overrides

The Administrative Override feature for Web Filtering is found by going to Security Profiles > Web Filter and
then enabling Allow users to override blocked categories.
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The Concept

When a Web filter profile is overridden, it does not necessarily remove all control and restrictions that were
previously imposed by the Web Filter. The idea is to replace a restrictive filter with a different one. In practice, it
makes sense that this will likely be a profile that is less restrictive the original one but there is nothing that forces
this. The degree to which the alternate profile is less restrictive is open. It can be as much as letting the user
access everything on the Internet or as little as allowing only one addition website. The usual practice is to have
as few alternate profiles as are needed to allow approved people to access what they need during periods when
an exception to the normal rules is needed but still having enough control that the organizations web usage
policies are not compromised.

You are not restricted to having only one alternative profile as an option to the existing profile. The new profile
depends on the credentials or IP address making the connection. For example, John connecting through the
"Standard" profile could get the "Allow_Streaming_Video" profile while George would get the "Allow_Social_
Networking_Sites" profile.

The other thing to take into account is the time factor on these overrides. They are not indefinite. The longest that
an override can be enabled is for 1 year less a minute. Often these overrides are set up for short periods of time
for specific reasons such as a project. Having the time limitation means that the System Administrator does not
have to remember to go back and turn the feature off after the project is finished.

Identity or Address

In either case, these override features -- for specified users, user groups or IP addresses -- allow sites blocked by
Web Filtering profiles to be overridden for a specified length of time. The drawback of this method of override is
that it takes more planning and preparation than the rating override method. The advantage is that once this has
been set up, this method requires very little in the way of administrative overhead to maintain.

When planning to use the alternative profile approach keep in mind the following: In Boolean terms, one of the
following "AND" conditions has to be met before overriding the Web Filter is possible.

Based on the IP address:

l The Web Filter profile must be specified as allowing overrides
l AND the user's computer is one of the IP addresses specified
l AND the time is within the expiration time frame.

While the conditions are fewer for this situation, there is less control over who has the ability to bypass the
filtering configured for the site. All someone has to do is get on a computer that is allowed to override the Web
Filter and they have access.

Based on user group:

l The Web Filter profile must be specified as allowing overrides
l AND the policy the traffic is going through must be identity based
l AND the user's credentials matches the identity credentials specified
l AND the time is within the expiration time frame.

This method is the one most likely to be used as it gives more control in that the user has to have the correct
credential and is more versatile because the user can use the feature from any computer that uses the correct
policy to get out on the Internet.
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Settings

When using an alternate profile approach to Web Filter overrides, the following settings are used to determine
authentication and outcome. Not every setting is used in both methods but enough of them are common to
describe them collectively.

Apply to Group(s)

This is found in the Allow Blocked Overrides configuration. Individual users can not be selected. You can select
one or more of the User Groups that are recognized my the FortiGate unit, whether they are local to the system or
from a third part authentication device such as a AD server through FSSO.

Original Profile

This is found in the Administrative Override configuration. In the Allow Blocked Overrides setting the
configuration is right inside the profile so there is no need to specify which profile is the original one, but the
Administrative Override setup is done separately from the profiles themselves.

Assign to Profile or New Profile

Despite the difference in the name of the field, this is the same thing in both variations of the feature. You select
from the drop down menu the alternate Web Filter Profile that you wish to set up for this override.

Scope or Scope Range

When setting up the override in the "Allow Blocked Overrides" variation, you are given a drop-down menu next to
the field name Scope while in the Administrative Override configuration you are asked to select a radio button
next to the same options. In both cases this is just a way of selecting which form of credentials will be required to
approve the overriding of the existing Web Filter profile.

When the Web Filter Block Override message page appears it will display a field named "Scope:" and depending
on the selection, it will show the type of credentials used to determine whether or not the override is allowed. The
available options are:

l User
This means that the authentication for permission to override will be based on whether or not the user is using a
specific user account.

l User Group
This means that the authentication for permission to override will be based on whether on not the user account
supplied as a credential is a member of the specified User Group.

l IP
This means that the authentication for permission to override will be based on the IP address of the computer that
was used to authenticate. This would be used with computers that have multiple users. Example: If Paul logs on to
the computer, engages the override using his credentials and then logs off, if the scope was based on the IP
address of the computer, anybody logging in with any account on that computer would now be using the alternate
override Web Filter profile.

When entering an IP address in the Administrative Override version, only individual IP addresses are allowed.

Differences between IP and Identity based scope
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l Using the IP scope does not require the use of an Identity based policy.
l When using the Administrative Override variation and IP scope, you may not see a warning message when you

change from using the original Web Filter profile to using the alternate profile. There is no requirement for
credentials from the user so, if allowed, the page will just come up in the browser.

l Ask
This option is available only in the "Allowed Blocked Overrides" variation and when used configures the message
page to ask which scope the user wished to use. Normally, when the page appears the scope options are greyed out
and not editable, but by using the ask option the option is dark and the user can choose from the choice of:
l User
l User Group
l IP Address

l Switch Duration
The Administrative Override sets a specified time frame that is always used for that override. The available options
are:

l Predefined
Using this setting will mean that what ever is set as the duration will be the length of time that the override will
be in effect. If the duration variable is set to 15 minutes the length of the override will always be 15 minutes.
The option will be visible in the Override message page but the setting will be greyed out.

l Ask
Using this setting will give the person the option of setting the duration to the override when it is engaged. The
user can set the duration in terms of Day, Hours and or Minutes.

l Duration
Duration is one of the areas where the two variations take a different approach, on two aspects of the setting. As
already indicated the "Administrative Override" only uses a static time frame there is no option for the user to select
on the fly how long it will last. The other way in which the two variation differ is that the "Allow Blocked Overrides"
starts the clock when the user logs in with his credentials. For example, if the duration is 1 hour and John initiates
an override at 2:00 p.m. on January 1, at the end of that hour he will revert back to using the original profile but he
can go back and re-authenticate and start the process over again. The Administrative override variation starts the
clock from when the override was configured, which is why is shows an expiration date and time when your are
configuring it.

This option, which is available when the Switch Mode is set to Predefined is the time in minutes that the override
will last when engaged by the user.

When setting up a constant duration in the Web Based Interface, minutes is the only option for units of time. To set
a longer time frame or to use the units of hours or days you can use the CLI.

config webfilter profile
edit <name of webfilter profile>

config override
set ovrd-dur <###d##h##m>

end
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When configuring the duration you don't have to set a value for a unit you are not
using. If you are not using days or hours you can use:

set ovrd-dur 30m

instead of:
set ovrd-dur 0d0h30m

However, each of the units of time variable has their own maximum level:
###d cannot be more than 364
##h cannot be more than 23
##m cannot be more than 59

So the maximum length that the override duration can be set to is 364 days, 23 hours,
and 59 minutes.

Using cookies to authenticate users in a Web Filter override
Cookies can be used to authenticate users when a web filter override is used. This feature is available in CLI only.

CLI Syntax:

config webfilter cookie-ovrd
set redir-host <name or IP>
set redir-port <port>

end

config webfilter profile
edit <name>

config override
set ovrd-cookie [allow | deny]
set ovrd-scope [user | user-group | ip | ask]
set profile-type [list | radius]
set ovrd-dur-mode [constant | ask]
set ovrd-dur <duration>
set ovrd-user-group <name>
set profile <name>

end
end

end

Web Profile Overrides
This feature allows administrators to grant temporary access to sites that are otherwise blocked by a web filter
profile. The temporary access can be granted to a user, user group, or source IP address. The time limit can be
set in days, hours, or minutes. The default is 15 minutes.

Temporary access can also be granted to a user, user group, or source IP address by enabling Allow users to
override blocked categories in a Web Filter security profile and applying that profile to the appropriate policy.
In this scenario, the user will have to authenticate to gain access.

When Web Profile Overrides is in effect, a blocked access page or replacement message will not appear and
authentication will not be required.
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If your FortiGate is operating in flow-based inspection and policy-based NGFWmode,
then you cannot create a web profile override.

Creating a Web Profile Override

Before creating a Web Profile Override, you will have to configure a user or user group if not granting temporary
access to a Source IP. You will also have to configure the Web Filter security profile to be applied to the override.

1. Go to Security Profiles > Web Profile Overrides.
2. Select Create New.

3. Select:
l The Scope Range: User and User Group should be previously configured underUser & Device
l TheOriginal Profile that applied to the scope range.
l The New Profile to apply for the override
l The time when the override Expires; default is 15 minutes

SafeSearch
SafeSearch is a feature of popular search sites that prevents explicit web sites and images from appearing in
search results. Although SafeSearch is a useful tool, especially in educational environments, the resourceful user
may be able to simply turn it off. Enabling SafeSearch for the supported search sites enforces its use by rewriting
the search URL to include the code to indicate the use of the SafeSearch feature. For example, on a Google
search it would mean adding the string “&safe=active” to the URL in the search.

The search sites supported are:

l Google
l Yahoo
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l Bing
l Yandex

You can only enable SafeSearch with proxy-based inspection mode.

Enabling SafeSearch - GUI

1. Go to Security Profiles > Web Filter and edit or create a policy.
2. Expand Search Engines

Enabling SafeSearch - CLI

config webfilter profile
edit default

config web
set safe-search <url>

end
end

This enforces the use of SafeSearch in traffic controlled by the firewall policies using the web filter you configure.

Search Keywords

There is also the capability to log the search keywords used in the search engines.

YouTube Education Filter
YouTube for Schools was a way to access educational videos from inside a school network. This YouTube feature
gave schools the ability to access a broad set of educational videos on YouTube EDU and to select the specific
videos that are accessible from within the school network.

Google decided to stop supporting YouTube for Schools (YTfS) as of July 1, 2016. Consequently, the current
YouTube safe search does not work anymore.

Google provides an article entitled "Restrict YouTube content on your network or managed devices" on its support
site. At this time, Google offers two options to restrict inappropriate content: DNS and HTTP header.

In FortiOS 5.6 with inspection mode set to proxy-based, in a Web Filter profile under Search Engines you can
select Restrict YouTube Access and select either Strict orModerate.
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Static URL Filter
You can allow or block access to specific URLs by adding them to the Static URL Filter list. The filter allows you
to block, allow, or monitor URLs by using patterns containing text, regular expressions, or wildcard characters.
The FortiGate unit allows or blocks web pages matching any specified URLs or patterns and displays a
replacement message instead.

URL blocking does not block access to other services that users
can access with a web browser. For example, URL blocking does
not block access to ftp:// ftp.example.com. Instead, use firewall
policies to deny ftp connections.

When adding a URL to the URL filter list, follow these rules:

l Type a top-level URL or IP address to control access to all pages on a web site. For example, www.example.com
or 192.168.144.155 controls access to all pages at this web site.

l Enter a top-level URL followed by the path and file name to control access to a single page on a web site. For
example, www.example.com/news.html or 192.168.144.155/news.html controls access to the news
page on this web site.

l To control access to all pages with a URL that ends with example.com, add example.com to the filter list. For
example, adding example.com controls access to www.example.com, mail.example.com,
www.finance.example.com, and so on.

l Control access to all URLs that match patterns using text and regular expressions (or wildcard characters). For
example, example.* matches example.com, example.org, example.net and so on.

URLs with an action set to exempt or monitor are not scanned for viruses. If users on
the network download files through the FortiGate unit from a trusted web site, add the
URL of this web site to the URL filter list with an action to pass it so the FortiGate unit
does not virus scan files downloaded from this URL.

URL formats

How URL formats are detected when using HTTPS

Filter HTTPS traffic by entering a top level domain name, for example, www.example.com if:
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l your unit does not support SSL content scanning and inspection
l you have selected the URL filtering option in web content profile forHTTPS content filtering mode under
Protocol Recognition.

HTTPSURL filtering of encrypted sessions works by extracting the CN from the server certificate during the SSL
negotiation. Since the CN only contains the domain name of the site being accessed, web filtering of encrypted
HTTPS sessions can only filter by domain names.

If your unit supports SSL content scanning and inspection and if you have selected Deep Scan, you can filter
HTTPS traffic in the same way as HTTP traffic.

How URL formats are detected when using HTTP

URLs with an action set to Exempt are not scanned for viruses. If users on the network download files through the
unit from trusted web site, add the URL of this web site to the URL filter list with an action set to exempt so the
unit does not virus scan files downloaded from this URL.

l Type a top-level URL or IP address to control access to all pages on a web site. For example, www.example.com
or 192.168.144.155 controls access to all pages at this web site.

l Enter a top-level URL followed by the path and filename to control access to a single page on a web site. For
example, www.example.com/news.html or 192.168.144.155/news.html controls the news page on
this web site.

l To control access to all pages with a URL that ends with example.com, add example.com to the filter list. For
example, adding example.com controls access to www.example.com, mail.example.com,
www.finance.example.com, and so on.

l Control access to all URLs that match patterns created using text and regular expressions (or wildcard characters).
For example, example.* matches example.com, example.org, example.net and so on.

l Fortinet URL filtering supports standard regular expressions.

If virtual domains are enabled on the unit, web filtering features are configured
globally. To access these features, select Global Configuration on the main menu.

URL Filter actions

You can select one of four actions for how traffic will be treated as it attempts to reach a site in the list.

Block

Attempts to access any URLs matching the URL pattern are denied. The user will be presented with a
replacement message.

Allow

Any attempt to access a URL that matches a URL pattern with an allow action is permitted. The traffic is passed
to the remaining antivirus proxy operations, including FortiGuard Web Filter, web content filter, web script filters,
and antivirus scanning.

Allow is the default action. If a URL does not appear in the URL list, it is permitted.
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Monitor

Traffic to, and reply traffic from, sites matching a URL pattern withMonitor action applied will be allowed
through in the same way as the Allow action. The difference with theMonitor action is that a log message will
be generated each time a matching traffic session is established. The requests will also be subject to all other
Security Profiles inspections that would normally be applied to the traffic.

Exempt

Exempt allows trusted traffic to bypass the antivirus and DLP proxy operations by default, but it functions slightly
differently. In general, if you’re not certain that you need to use the Exempt action, useMonitor.

Using the static URL filter to exempt scanning also prevents SSL inspection.

HTTP 1.1 connections are persistent unless declared otherwise. This means the connections will remain in place
until closed or the connection times out. When a client loads a web page, the client opens a connection to the
web server. If the client follows a link to another page on the same site before the connection times out, the same
connection is used to request and receive the page data.

When you add a URL pattern to a URL filter list and apply the Exempt action, traffic sent to and replies traffic
from sites matching the URL pattern will bypass all antivirus proxy operations. The connection itself inherits the
exemption. This means that all subsequent reuse of the existing connection will also bypass all antivirus proxy
operations. When the connection times out, the exemption is cancelled.

For example, consider a URL filter list that includes example.com/files configured with the Exempt action.
A user opens a web browser and downloads a file from the URL example.com/sample.zip. This URL does
not match the URL pattern so it is scanned for viruses. The user then downloads
example.com/files/beautiful.exe and since this URL does match the pattern, the connection itself
inherits the exempt action. The user then downloads example.com/virus.zip. Although this URL does not
match the exempt URL pattern, a previously visited URL did, and since the connection inherited the exempt
action and was re-used to download a file, the file is not scanned.

If the user next goes to an entirely different server, like example.org/photos, the connection to the current
server cannot be reused. A new connection to example.org is established. This connection is not exempt. Unless
the user goes back to example.com before the connection to that server times out, the server will close the
connection. If the user returns after the connection is closed, a new connection to example.com is created and it
is not exempt until the user visits a URL that matches the URL pattern.

Web servers typically have short time-out periods. A browser will download multiple components of a web page
as quickly as possible by opening multiple connections. A web page that includes three photos will load more
quickly if the browser opens four connections to the server and downloads the page and the three photos at the
same time. A short time-out period on connections will close the connections faster, allowing the server to avoid
unnecessarily allocating resources for a long period. The HTTP session time-out is set by the server and will vary
with the server software, version, and configuration.

Using the Exempt action can have unintended consequences in certain circumstances. You have a web site at
example.com and since you control the site, you trust the contents and configure example.com as exempt. But
example.com is hosted on a shared server with a dozen other different sites, each with a unique domain name.
Because of the shared hosting, they also share the same IP address. If you visit example.com, your connection
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your site becomes exempt from any antivirus proxy operations. Visits to any of the 12 other sites on the same
server will reuse the same connection and the data you receive is exempt from being scanned.

Use of the Exempt action is not suitable for configuration in which connections through the FortiGate unit use an
external proxy. For example, you use proxy.example.net for all outgoing web access. Also, as in the first
example, URL filter list that includes a URL pattern of example.com/files configured with the Exempt
action. Users are protected by the antivirus protection of the FortiGate unit until a user visits a URL that matches
the of example.com/files URL pattern. The pattern is configured with the Exempt action so the connection
to the server inherits the exemption. With a proxy however, the connection is from the user to the proxy.
Therefore, the user is entirely unprotected until the connection times out, no matter what site he visits.

Ensure you are aware of the network topology involving any URLs to which you apply the Exempt action.

Status

The Web Site Filter has the option to either enable or disable individual web sites in the list. This allows for the
temporary removal of the actions against a site so that it can be later reengaged without having to rewrite the
configuration.

Configuring a URL filter

You can only set a Static URL Filter with proxy-based inspection mode and flow-
based inspection mode in profile-based NGFWmode.

For this example, the URL www.example*.com will be used. You configure the list by adding one or more URLs to
it.

To add a URL to a URL filter

1. Go to Security Profiles > Web Filter.
2. Create a new web filter or select a one to edit.
3. Expand Static URL Filter, enable URL Filter, and select Create.
4. Enter the URL, without the “http”, for example: www.example*.com.
5. Select a Type: Simple , Reg. Expression, orWildcard. In this example, selectWildcard.
6. Select the Action to take against matching URLs: Exempt, Block, Allow, orMonitor.
7. Confirm that Status is enabled.
8. Select OK.

'Simple' Filter type

If you select the Simple filter type for a URL filter, the syntax is performing an exact match. Note, however, that
the domain and path are separate entities in HTTP despite the fact that a user types them as a single entity and,
in the case of 'simple', the rules for each part (domain and path) are different.

The 'domain' part

For the domain part, the goal of the 'simple' format is to make it easy to block a domain and all its subdomains,
such that the admin only has to type “address.xy" to block "address.xy", "www.address.xy", "talk.address.xy", etc.
but not block “youraddress.xy" or "www.youraddress.xy" which are different domains from "address.xy”.
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Also, the actual domain does not include http:// or https:// so this should not be entered or the URL filter will try to
match a domain starting with http. For this reason, when you enter http:// in the URL filter via the GUI, it is
automatically removed.

A trailing ‘/‘ with the domain is not needed. The GUI URL filter will automatically trim
this, but when using the API to provide the per-user BWL it will not!

Please take this into account. Better not to use it as it might give unexpected results.

The 'path' part

For the path part, an exact match takes place. For example:

www.address.xy/news

blocks anything that starts with that exact path. So this matches:

www.address.xy/newsies
www.address.xy/newsforyou
www.address.xy/news/co
etc.

Also:

www.address.xy/new

likewise blocks the same as above but includes:

/newt
/newp
etc.

which is a much broader filter, matching:

www.address.xy/newstand/co
www.address.xy/news/co
etc.

In other words, the more you specify of the path, the more strictly it will match.

Here as well a trailing ‘/‘ with the URL path is not needed, the GUI URL filter will
automatically trim this, but when using the API to provide the per-user BWL it will not!

Please take this into account. Better not to use it as it might give unexpected results.

Referrer URL

A new variable has been added to the Static URL Filter: referrer-host. If a referrer is specified, the
hostname in the referrer field of the HTTP require will be compared for any entry that contains the matching URL.
If the referrer matches, then the specified action will be performed by proxy.

Configuring in the GUI

The configuration can be done in the GUI but only if advance web filtering features have been enabled by
entering the following commands in the CLI:
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config system global
set gui-webfilter-advanced enable

end

After this command is used, a new column will be created in Security Profiles > Web Filter to set the referrer.

Configuring in the CLI

When specifying the URL filter, it needs to be identified by its ID. The URLs are listed under each entry.

To find the ID number:

config webfilter urlfilter
edit ?

A list of the current URL filters will be listed with their ID numbers in the left column.

The syntax in the CLI for configuring an entry is:

config webfilter urlfilter
edit <ID>

config entries
edit 1

set url <url>
set referrer-host <url>
set type {simple | regex | wildcard}
set action {block | allow | monitor | exempt}
set status {enable | disable}

end
end

end

Web content filter
You can control web content by blocking access to web pages containing specific words or patterns. This helps to
prevent access to pages with questionable material. You can also add words, phrases, patterns, wild cards and
Perl regular expressions to match content on web pages. You can add multiple web content filter lists and then
select the best web content filter list for each web filter profile.

Enabling web content filtering involves three separate parts of the FortiGate configuration.

l The security policy allows certain network traffic based on the sender, receiver, interface, traffic type, and time of
day.

l The web filter profile specifies what sort of web filtering is applied.
l The web content filter list contains blocked and exempt patterns.

The web content filter feature scans the content of every web page that is accepted by a security policy. The
system administrator can specify banned words and phrases and attach a numerical value, or score, to the
importance of those words and phrases. When the web content filter scan detects banned content, it adds the
scores of banned words and phrases in the page. If the sum is higher than a threshold set in the web filter profile,
the FortiGate unit blocks the page.

General configuration steps

Follow the configuration procedures in the order given. Also, note that if you perform any additional actions
between procedures, your configuration may have different results.
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1. Create a web content filter list.
2. Add patterns of words, phrases, wildcards, and regular expressions that match the content to be blocked or

exempted.
3. You can add the patterns in any order to the list. You need to add at least one pattern that blocks content.
4. In a web filter profile, enable the web content filter and select a web content filter list from the options list.
To complete the configuration, you need to select a security policy or create a new one. Then, in the security
policy, enableWebfilter and select the appropriate web filter profile from the list.

Creating a web filter content list

You can create multiple content lists and then select the best one for each web filter profile. Creating your own
web content lists can be accomplished only using the CLI.

This example shows how to create a web content list called inappropriate language, with two entries, offensive
and rude.

To create a web filter content list

config webfilter content
edit 3

set name "inappropriate language"
config entries

edit offensive
set action block
set lang western
set pattern-type wildcard
set score 15
set status enable

next
edit rude

set action block
set lang western
set pattern-type wildcard
set score 5
set status enable

end
end

end

Configuring a web content filter list

Once you have created the web filter content list, you need to add web content patterns to it. There are two types
of patterns:Wildcard and Regular Expression.

You use theWildcard setting to block or exempt one word or text strings of up to 80 characters. You can also use
the wildcard symbols, such as “*” or “?”, to represent one or more characters. For example, as a wildcard
expression, forti*.com will match fortinet.com and forticare.com. The “*” represents any kind of character
appearing any number of times.

You use the Regular Expression setting to block or exempt patterns of Perl expressions, which use some of the
same symbols as wildcard expressions, but for different purposes. The “*” represents the character before the
symbol. For example, forti*.com will match fortiii.com but not fortinet.com or fortiice.com. The symbol “*”
represents “i” in this case, appearing any number of times. RP: Add a regex example.

The maximum number of web content patterns in a list is 5000.
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How content is evaluated

Every time the web content filter detects banned content on a web page, it adds the score for that content to the
sum of scores for that web page. You set this score when you create a new pattern to block the content. The
score can be any number from zero to 99999. Higher scores indicate more offensive content. When the sum of
scores equals or exceeds the threshold score, the web page is blocked. The default score for web content filter is
10 and the default threshold is 10. This means that by default a web page is blocked by a single match. Blocked
pages are replaced with a message indicating that the page is not accessible according to the Internet usage
policy.

Banned words or phrases are evaluated according to the following rules:

l The score for each word or phrase is counted only once, even if that word or phrase appears many times in the web
page.

l The score for any word in a phrase without quotation marks is counted.
l The score for a phrase in quotation marks is counted only if it appears exactly as written.

The following table describes how these rules are applied to the contents of a web page. Consider the following,
a web page that contains only this sentence: “The score for each word or phrase is counted only once, even if that
word or phrase appears many times in the web page.”

Banned Pattern Rules

Banned
pattern

Assigned
score

Score added to
the sum for the
entire page

Threshold
score Comment

word 20 20 20 Appears twice but only counted once. Web page
is blocked.

word
phrase 20 40 20 Each word appears twice but only counted once

giving a total score of 40. Web page is blocked

word
sentence

20 20 20 “word” appears twice, “sentence” does not
appear, but since any word in a phrase without
quotation marks is counted, the score for this
pattern is 20. Web page is blocked.

“word
sentence” 20 0 20 “This phrase does not appear exactly as written.

Web page is allowed.

“word or
phrase”

20 20 20 This phrase appears twice but is counted only
once. Web page is blocked.

Enabling the web content filter and setting the content threshold

When you enable the web content filter, the web filter will block any web pages when the sum of scores for
banned content on that page exceeds the content block threshold. The threshold will be disregarded for any
exemptions within the web filter list.
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Web filtering example
Web filtering is particularly important for protecting school-aged children. There are legal issues associated with
improper web filtering as well as a moral responsibility to keep children from viewing inappropriate material. The
key is to design a web filtering system in such a way that students and staff do not fall under the same web filter
profile in the FortiGate configuration. This is important because the staff may need to access websites that are
off limits to the students.

School district

The background for this scenario is a school district with more than 2,300 students and 500 faculty and staff in a
preschool, three elementary schools, a middle school, a high school, and a continuing education center. Each
elementary school has a computer lab and the high school has three computer labs with connections to the
Internet. Such easy access to the Internet ensures that every student touches a computer every day.

With such a diverse group of Internet users, it was not possible for the school district to set different Internet
access levels. This meant that faculty and staff were unable to view websites that the school district had blocked.
Another issue was the students’ use of proxy sites to circumvent the previous web filtering system. A proxy server
acts as a go-between for users seeking to view web pages from another server. If the proxy server has not been
blocked by the school district, the students can access the blocked website.

When determining what websites are appropriate for each school, the district examined a number of factors, such
as community standards and different needs of each school based on the age of the students.

The district decided to configure the FortiGate web filtering options to block content of an inappropriate nature
and to allow each individual school to modify the options to suit the age of the students. This way, each individual
school was able to add or remove blocked sites almost immediately and have greater control over their students’
Internet usage.

In this simplified example of the scenario, the district wants to block any websites with the word example on
them, as well as the website www.example.com. The first task is to create web content filter lists for the students
and the teachers.

Web Filter in flow mode does not support Safe Search. The examples below use Web
Filter in proxy mode.

Create a Web Filter profile for the students

1. Go to Security Profiles > Web Filter.
2. Select the Create New icon.
3. Enter the name “Students” in the name field.
4. Enable FortiGuard Categories.

a. Set the following categories to Block:
l Potentially Liable
l Adult/Mature Content
l Security Risk

URL Content
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6. Go to Search Engines and expand the section if necessary. Enable Enforce 'Safe Search' on Google,
Yahoo!, Bing, Yandex

7. In the Static URL Filter section, enable URL Filter.

a. Select Create New.

i. In the URL field, enter *example*.*
ii. For the Type field, selectWildcard
iii. For the Action field, select Block
iv. For the Status field, check enable
v. Select OK

Web Content Filter

8. In the Static URL Filter section, enable Web Content Filter.

a. In theWeb Content Filter widget, select Create New.

i. For the Pattern Type field, select Reg. Expression
ii. In the Pattern field, enter “example”
iii. For the Language field, choose Western
iv. For the Action field, select “Block”
v. For the Status field, check Enable.
vi. Select OK

9. EnableRate URLs by Domain and IP Address
10. Disable Allow websites when a rating error occurs .
11. CheckRate Images by URL (Blocked images will be replaced with blanks)
12. Select Apply

Create a Web Filter for the teachers

It might be more efficient if the Teacher Web Content List included the same blocked content as the student list.
From time to time a teacher might have to view a blocked page. It would then be a matter of changing the Action
from Block to Allow as the situation required. The following filter is how it could be set up for the teachers to
allow them to see the “example” content if needed while keeping the blocking inappropriate material condition.

1. Go to Security Profiles > Web Filter.
2. Select the Create New icon.
3. Enter the name “Teachers” in the name field.
4. Enable FortiGuard Categories.

a. Set the following categories to Block:
l Potentially Liable
l Adult/Mature Content
l Security Risk

URL Content

6. Go to Search Engines and expand the section if necessary. Enable Search Engine Safe Search on Google,
Yahoo!, Bing, Yandex.

7. In the Static URL Filter section, checkEnable URL Filter.

a. Select Create New.
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i. In the URL field, enter *example*.*
ii. For the Type field, selectWildcard
iii. For the Action field, select Block
iv. For the Status field, check enable
v. Select OK

Web Content Filter

8. In the Static URL Filter section, check Enable Web Content Filter.

a. In the Web Content Filter widget, select Create New.

b. Enter the name “Teachers” in the name field.

i. For the Pattern Type field, select Reg. Expression
ii. In the Pattern field, enter “example”
iii. For the Language field, choose Western
iv. For the Action field, select Exempt
v. For the Status field, check Enable.
vi. Select OK

9. CheckRate URLs by Domain and IP Address
10. CheckRate Images by URL (Blocked images will be replaced with blanks)
11. Select OK

To create a security policy for the students

1. Go to Policy & Objects > IPv4 Policy.
2. Select the policy being used to manage student traffic.
3. Enable Web Filter.
4. Select Students from the web filter drop-down list.
5. Select OK.

To create a security policy for Teachers

1. Go to Policy & Objects > IPv4 Policy.
2. Select the policy being used to manage teacher traffic.
3. Enable Web Filter.
4. Select Teachers from the web filter drop-down list.
5. Select OK.
6. Make sure that the student policy is in the sequence before the teachers’ policy.

Advanced web filter configurations

Allow websites when a rating error occurs

Enable this setting to allow access to web pages that return a rating error from the FortiGuard Web Filter service.
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If your FortiGate unit cannot contact the FortiGuard service temporarily, this setting determines the tye of access
the FortiGate unit allows until contact is re-established. If enabled, users will have full unfiltered access to all web
sites. If disabled, users will not be allowed access to any web sites.

ActiveX filter

Enable to filter ActiveX scripts from web traffic. Web sites using ActiveXmay not function properly with this filter
enabled.

Block Invalid URLs

Select to block web sites when their SSL certificate CN field does not contain a valid domain name.

FortiGate units always validate the CN field, regardless of whether this option is enabled. However, if this option
is not selected, the following behavior occurs:

l If the request is made directly to the web server, rather than a web server proxy, the FortiGate unit queries for
FortiGuard Web Filtering category or class ratings using the IP address only, not the domain name.

l If the request is to a web server proxy, the real IP address of the web server is not known. Therefore, rating queries
by either or both the IP address and the domain name is not reliable. In this case, the FortiGate unit does not
perform FortiGuard Web Filtering.

Enabling the Web Filter profile to block a particular category and enabling the
Application Control profile will not result in blocking the URL. This occurs because
proxy and flow-based profiles cannot operate together.

To ensure replacement messages show up for blocked URLs, switch the Web Filter to
flow-based inspection.

Cookie filter

Enable to filter cookies from web traffic. Web sites using cookies may not function properly with this enabled.

Provide Details for Blocked HTTP 4xx and 5xx Errors

Enable to have the FortiGate unit display its own replacement message for 400 and 500-series HTTP errors. If
the server error is allowed through, malicious or objectionable sites can use these common error pages to
circumvent web filtering.

HTTP POST action

Select the action to take with HTTP POST traffic. HTTP POST is the command used by your browser when you
send information, such as a form you have filled-out or a file you are uploading, to a web server.

The available actions include:

Comfort

Use client comforting to slowly send data to the web server as the FortiGate unit scans the file. Use this option to
prevent a server time-out when scanning or other filtering is enabled for outgoing traffic.

The client comforting settings used are those defined in the Proxy Options profile selected in the security policy.
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Block

Block the HTTP POST command. This will limit users from sending information and files to web sites.

When the post request is blocked, the FortiGate unit sends the http-post-block replacement message to the web
browser attempting to use the command.

Java applet filter

Enable to filter java applets from web traffic. Web sites using java applets may not function properly with this filter
enabled.

Rate Images by URL

Enable to have the FortiGate retrieve ratings for individual images in addition to web sites. Images in a blocked
category are not displayed even if they are part of a site in an allowed category.

Blocked images are replaced on the originating web pages with blank place-holders. Rated image file types
include GIF, JPEG, PNG, BMP, and TIFF.

Rate URLs by Domain and IP Address

Enable to have the FortiGate unit request the rating of the site by URL and IP address separately, providing
additional security against attempts to bypass the FortiGuard Web Filter.

If the rating determined by the domain name and the rating determined by the IP address defer the Action that is
enforce will be determined by a weighting assigned to the different categories. The higher weighted category will
take precedence in determining the action. This will have the side effect that sometimes the Action will be
determined by the classification based on the domain name and other times it will be determined by the
classification that is based on the IP address.

FortiGuard Web Filter ratings for IP addresses are not updated as quickly as ratings for
URLs. This can sometimes cause the FortiGate unit to allow access to sites that
should be blocked, or to block sites that should be allowed.

An example of how this would work would be if a URL’s rating based on the domain name indicated that it
belonged in the category Lingerie and Swimsuit, which is allowed but the category assigned to the IP address was
Pornography which has an action of Block, because the Pornography category has a higher weight the effective
action is Block.

Web resume download block

Enable to prevent the resumption of a file download where it was previously interrupted. With this filter enabled,
any attempt to restart an aborted download will download the file from the beginning rather than resuming from
where it left off.

This prevents the unintentional download of viruses hidden in fragmented files.

Note that some types of files, such as PDF, fragment files to increase download speed and enabling this option
can cause download interruptions. Enabling this option may also break certain applications that use the Range
Header in the HTTP protocol, such as YUM, a Linux update manager.
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Restrict Google account usage to specific domains

This feature allow the blocking of access to some Google accounts and services while allowing access to
accounts that are included in the domains specified in the exception list.

Block non-English character URLs

The FortiGate will not successfully block non-English character URLs if they are added to the URL filter. In order
to block access to URLs with non-English characters, the characters must be translated into their international
characters.

Browse to the non-English character URL (for example, http://www.fortinet.com/pages/ท ี ่ น ี ่ -ไ ม ่ ม ี เ ศ ษ ร ั ฐป ร ะ
ห าร ใ ห ้ ใ ค ร แ ด ก /338419686287505?ref=stream).

On the FortiGate, use the URL shown in the FortiGate GUI and add it the list of blocked URLs in your URL filter
(for example,
http://www.fortinet.com/pages/%E0%B8%97%E0%B8%B5%E0%B9%88%E0%B8%99%E0%B8%B5%E0%B9%
88-%E0%B9%84%E0%B8%A1%E0%B9%88%E0%B8%A1%E0%B8%B5%E0%B9%80%E0%B8%A8%E0%B8%
A9%E0%B8%A3%E0%B8%B1%E0%B8%90%E0%B8%9B%E0%B8%A3%E0%B8%B0%E0%B8%AB%E0%B8%
B2%E0%B8%A3%E0%B9%83%E0%B8%AB%E0%B9%89%E0%B9%83%E0%B8%84%E0%B8%A3%E0%B9%
81%E0%B8%94%E0%B8%81/338419686287505?ref=stream).

Once added, further browsing to the URL will result in a blocked page.

CLI Syntax

config webfilter urlfilter
edit 1

set name "block_international_character_urls"
config entries

edit 1
set url "www.fortinet.com/pages/2.710850E-3120%B8%E0%B8%B53.231533E-

3170%B9%E0%B8%E0%B8%B53.231533E-3170%B9%88-3.230415E-
3170%B9%E0%B80X0.000000063CD94P-102211.482197E-
3230%B9%E0%B80X0.0007FBFFFFCFP-102210.000000E+000%B8%B51.828043E-
3210%B9%E0%B80X0P+081.828043E-3210%B80X0P+092.710850E-
3120%B80X0.0000000407ED2P-102233.236834E-3170%B8%B19.036536E-
3130%B8%E0%B8%9B4.247222E-3140%B80X0P+039.036683E-3130%B8%B02.121996E-
3130%B80X0.0000000000008P-1022B2.710850E-3120%B8%B21.482197E-
3230%B80X0P+030.000000E+000%B9%E0%B80X0P+0B2.710850E-
3120%B9%E0%B9%E0%B8%E0%B80X0.0000000408355P-102232.023693E-
3200%B9%E0%B8%E0%B8%81/338419686287505?ref=stream"

set action block
next

end
next

end

config webfilter urlfilter
edit 2

set name "block_international_character_urls"
next

end

config webfilter profile
edit "block_international_character_urls"
next
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end

config firewall policy
edit 3

set uuid cf80d386-7bcf-51e5-6e87-db207e3f0fa8
set srcintf "port1"
set dstintf "port2"
set srcaddr "all"
set dstaddr "all"
set action accept
set schedule "always"
set service "ALL"
set utm-status enable
set logtraffic all
set webfilter-profile "block_international_character_urls"
set profile-protocol-options "default"
set ssl-ssh-profile "certificate-inspection"
set nat enable

next
end

Websense web filtering through WISP

WISP is a Websense protocol that allows for URLs to be extracted by a firewall and submitted to Websense
systems for rating and approval checking.

This feature provides a solution for customers who have large, existing, deployed implementations of Websense
security products to replace their legacy firewalls with a FortiGate family, such that they are not forced to make a
change to their web filtering infrastructure at the same time.

When WISP is enabled, the FortiGate will maintain a pool of TCP connections to the WISP server. The TCP
connections will be used to forward HTTP request information and log information to the WISP server and receive
policy decisions.

Configuring the WISP server

In order to use WebSense's web filtering service, a WISP server per VDOM must be defined and enabled first.

config web-proxy wisp

edit {name}

# Configure Wireless Internet service provider (WISP) servers.

set name {string} Server name. size[35]

set comment {string} Comment. size[255]

set outgoing-ip {ipv4 address any} WISP outgoing IP address.

set server-ip {ipv4 address any} WISP server IP address.

set server-port {integer} WISP server port (1 - 65535, default = 15868). range[1-65535]

set max-connections {integer} Maximum number of web proxy WISP connections (4 - 4096, default =

64). range[4-4096]

set timeout {integer} Period of time before WISP requests time out (1 - 15 sec, default = 5). range

[1-15]

next

end

Example configuration
config web-proxy wisp
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edit 0
set outgoing-ip 0.0.0.0
set server-ip 0.0.0.0
set server-port 15868
set max-connections 64
set timeout 5

next
end

After configuring the WISP server, enable WISP in the web filter profile.

config webfilter profile
edit "wisp_only"

set wisp enable
set wisp-servers 0

next
end

Now you can apply the web filter profile to a firewall policy.

If you configure more than one WISP server, the load balance option can also be configured.

config webfilter profile
edit "wisp_only"

set wisp-algorithm {primary-secondary | round-robin | auto-learning}
next

end

The options for the wisp-algorithm are:

l primary-secondary: select the first healthy server in order
l round-robin: select the next healthy server
l auto-learning select the lightest loading healthy server

DNS Filter

You can configure DNSweb filtering to allow, block, or monitor access to web content according to FortiGuard
categories. When DNSweb filtering is enabled, your FortiGate must use the FortiGuard DNS service for DNS
lookups. DNS lookup requests sent to the FortiGuard DNS service return with an IP address and a domain rating
that includes the FortiGuard category of the web page.

If that FortiGuard category is set to block, the result of the DNS lookup is not returned to the requester. If the
category is set to redirect, then the address returned to the requester points at a FortiGuard redirect page.

You can also allow or monitor access based on FortiGuard category.

Blocking DNS requests to known botnet command & control addresses

FortiGuard maintains a database containing a list of known botnet command and control (C&C) addresses. This
database is updated dynamically and stored on the FortiGate and requires a valid FortiGuard AntiVirus
subscription.
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When you block DNS requests to known botnet C&C addresses, using IPS, DNS lookups are checked against the
botnet C&C database. All matching DNS lookups are blocked. Matching uses a reverse prefix match, so all sub-
domains are also blocked.

To enable this feature, go to Security Profiles > DNS Filter, and enable Block DNS requests to known
botnet C&C.

Static Domain Filter

The DNSStatic Domain Filter allows you to block, exempt, or monitor DNS requests by using IPS to look inside
DNS packets and match the domain being looked up with the domains on the static URL filter list. If there is a
match the DNS request can be blocked, exempted, monitored, or allowed.

If blocked, the DNS request is blocked and so the user cannot look up the address and connect to the site.

If exempted, access to the site is allowed even if another method is used to block it.

CLI commands

Configure DNS URL filter:
config dnsfilter urlfilter

edit 1
set name "url1"
set comment ''

config entries
edit 1

set url "www.google.com"
set type simple
set action block
set status enable

next
edit 2

set url "www.yahoo.com"
set type simple
set action monitor
set status enable

next
edit 3

set url "www.foritnet.com"
set type simple
set action allow
set status enable

next
end

next
end

Configure DNS filter profile:
config dnsfilter profile

edit "dns_profile1"
set comment ''

config urlfilter
set urlfilter-table 1

end
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config ftgd-dns
config filters

edit 1
set category 49
set action block
set log enable

next
edit 2

set category 71
set action monitor
set log enable

next
end

end
set log-all-url disable
set block-action redirect
set redirect-portal 0.0.0.0
set block-botnet enable

next
end

Configure DNS profile in a firewall policy:
config firewall policy

edit 1
set srcintf "any"
set dstintf "any"
set srcaddr "all"
set dstaddr "all"
set action accept
set schedule "always"
set service "FTP"
set utm-status enable
set dnsfilter-profile "dns_profile1"
set profile-protocol-options "default"
set nat enable

next
end

Configure DNS profile in profile group:
config firewall profile-group

edit "pgrp1"
set dnsfilter-profile "dns_profile1"
set profile-protocol-options "default"

next
end

DNS profile supports safe search

With the release of FortiOS 5.6, users can take advantage of pre-defined DNS filter rules to edit DNS profiles and
provide safe search for Google, Bing, and YouTube.
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To add safe search to a DNS profile - GUI

1. Go to Security Profiles > DNS Filter.
2. Edit the default filter or create a new one.
3. Enable Enforce 'Safe Search on Google, Bing, YouTube.
4. Select Strict orModerate level of restriction for YouTube Access.

To add safe search to a DNS profile - CLI

config dnsfilter profile
edit "default"

set safe-search enable
set youtube-restrict {strict | moderate} (only available is safe-search enabled)

next
end

FortiGuard Botnet protection
Preventing botnets from controlling your system is achieved by detecting and blocking connection attempts to
known botnets. This feature also blocks connections to known phishing sites. The FortiGuard database is
continually updated with addresses of known Command and Control (C&C) sites that botnet clients attempt to
connect to, as well as a addresses of known phishing URLs.

To enable botnet and phishing protection in a DNS Filter profile, enable Block DNS requests to known botnet
C&C.

The latest botnet database is available from FortiGuard. To see the version of the database and display its
contents, go to System > FortiGuard > AntiVirus > and you will see data forBotnet IPs and Botnet
Domains. You can also block, monitor, or allow outgoing connections to botnet sites for each FortiGate
interface.

Both the DNS Filter security profile and Botnet protection features available for both
proxy-based and flow-based inspection modes.
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Using the Application Control Security Profiles feature, your FortiGate unit can detect and take action against
network traffic depending on the application generating the traffic. Based on FortiGate Intrusion Protection
protocol decoders, application control is a user-friendly and powerful way to use Intrusion Protection features to
log and manage the behavior of application traffic passing through the FortiGate unit. Application control uses
IPS protocol decoders that can analyze network traffic to detect application traffic even if the traffic uses non-
standard ports or protocols. Application control supports detection for traffic using HTTP protocol (versions 1.0,
1.1, and 2.0).

The FortiGate unit can recognize the network traffic generated by a large number of applications. You can create
application control sensors that specify the action to take with the traffic of the applications you need to manage
and the network on which they are active, and then add application control sensors to the firewall policies that
control the network traffic you need to monitor.

Fortinet is constantly adding to the list of applications detected through maintenance of the FortiGuard
Application Control Database. This database is part of the FortiGuard Intrusion Protection System Database
because intrusion protection protocol decoders are used for application control and both of these databases have
the same version number.

Cloud Access Security Inspection (CASI) is merged with Application Control resulting in changes to the GUI
and the CLI.

You can identify the version of the application control database installed on your unit by going to the Licenses
widget on the Dashboard and hovering over the IPS & Application Control line; the status, expiry date, and
version will be displayed. Additionally, you can see the complete list of applications supported by FortiGuard
Application Control on the FortiGuard site or http://fortiguard.com/appcontrol. This web page lists all of the
supported applications. You can select any application name to see details about the application.

Application Control is now a standard part of any FortiCare support contract and the
database for Application Control signatures is separate from the IPS database.
However, Botnet application signatures are still part of the IPS signature database
since these are more closely related with security issues and less about application
detection.

If you enable virtual domains (VDOMs) on the Fortinet unit, you must configure application control separately for
each virtual domain.

This Handbook chapter includes Inside FortiOS: Application Control and provides readers an overview of the
features and benefits of key FortiOS 5.6 components. For readers needing to delve into greater detail, we provide
the following topics:

Application control concepts
You can control network traffic generally by the source or destination address, or by the port, the quantity or
similar attributes of the traffic itself in the security policy. If you want to control the flow of traffic from a specific
application, these methods may not be sufficient to precisely define the traffic. To address this problem, the
application control feature examines the traffic itself for signatures unique to the application generating it.
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Application control does not require knowledge of any server addresses or ports. The FortiGate unit includes
signatures for over 2,000 applications, services, and protocols.

Updated and new application signatures are delivered to your FortiGate unit as part of your FortiGuard
Application Control Service subscription, which is a free service. Fortinet is constantly increasing the number of
applications that this feature can detect by adding applications to the FortiGuard Application Control Database.
Because intrusion protection protocol decoders are used for application control, the application control database
is part of the FortiGuard Intrusion Protection System Database. Both of these databases have the same version
number.

You can find the version of the application control database installed on your unit by going to the Licenses
widget on the Dashboard and hovering over the IPS& Application Control line; the status, expiry date, and
version will be displayed.

To see the complete list of applications supported by FortiGuard Application Control go to the FortiGuard site or
http://fortiguard.com/appcontrol. This web page lists all of the supported applications. You can select any
application name to see details about the application.

Cloud Access Security Inspection (CASI)
The Cloud Access Security Inspection (CASI) feature is now merged with Application Control resulting in changes
to the GUI and the CLI.

GUI Changes

l Toggle option added to quickly filter CASI signatures in the Application Signatures list.
l Application Overrides table now shows any parent-child hierarchy using the --parent metadata on signatures.

Deleting a parent app also deletes its child apps. And conversely, adding a child app will add all its parent apps but
with implicit filter action.

l A policy breakdown is shown on existing application control profiles for policies using the profile. The breakdown
indicates which policies are using a deep inspection.

l A breakdown is shown for application categories and filter overrides to indicate the number of CASI and non-CASI
signatures. A lock icon is shown for applications requiring deep inspection.

CLI Changes

Commands removed:

l config application casi profile

l casi profile in config firewall policy

l casi profile in config firewall policy6

l casi-profile-status and casi-profile under config firewall sniffer

l casi-profile-status and casi-profile under config firewall interface-policy

Enabling application control in profile-based modes
Application control examines your network traffic for traffic generated by the applications you want it to control.
The configuration steps outlined below are for FortiGate's operating in proxy-based inspection and flow-based
inspection with profile-based NGFWmodes. For FortiGate's operating in NGFW policy-based mode, see
Enabling application control in NGFW policy-based mode.
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General configuration steps

Follow the configuration procedures in the order given. Also, note that if you perform any additional actions
between procedures, your configuration may have different results.

1. Create an application sensor.
2. Configure the sensor to include the signatures for the application traffic you want the FortiGate unit to detect.
3. Enable any other applicable options.
4. Enable application control in a security policy and select the application sensor.

Creating an application sensor

You need to create an application sensor before you can enable application control.

To create an application sensor

1. Go to Security Profiles > Application Control.
2. Select the Create New icon in the title bar of the Edit Application Sensor window.
3. In the Name field, enter the name of the new application sensor.
4. Optionally, enter descriptive Comments.

Adding applications to an application sensor

Once you have created an application sensor, you need to need to define the applications that you want to
control. You can add applications and filters using categories, application overrides, and/or filter overrides.
Categories will allow you to choose groups of signatures based on a category type. Application overrides allow
you to choose individual applications. Filter overrides allow you to select groups of applications and override the
application signature settings for them.

To add a category of signatures to the sensor.

1. Go to Security Profiles > Application Control.
2. UnderCategories, you may select from the following:

l Business
l Cloud,.IT
l Collaboration
l Email
l Game
l General.Interest
l Industrial
l Mobile
l Network.Service
l P2P
l Proxy
l Remote.Access
l Social.Media
l Storage.Backup
l Update
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l Video/Audio
l VoIP
l Web.Client
l Unknown Applications

When selecting the category that you intend to work with, left click on the icon next to the category name to
see a drop down menu that includes these actions:

l Allow
l Monitor
l Block
l Quarantine
l View Signatures

These actions are briefly defined under Application Control actions on page 2864.

3. If you wish to add individual applications, select Add Signatures underApplication Overrides.

a. Use the Add Filter search field to narrow down the list of possible signatures by a series of attributes.

b. When finished, select Use Selected Signatures.
4. If you wish to add advanced filters, select Add Filter under Filter Overrides.

a. Use the Add Filter search field to narrow down the list of possible filters by a series of attributes.

b. When finished, select Use Filters.
4. Select, if applicable, from the following options:

l Allow and Log DNS Traffic
l Replacement Messages for HTTP-based Applications

6. Select OK.

Applying the application sensor to a security policy

An application sensor directs the FortiGate unit to scan network traffic only when it is selected in a security policy.
When an application sensor is selected in a security policy, its settings are applied to all the traffic the security
policy handles.

To select the application sensor in a security policy — GUI

1. Go to Policy & Objects > IPv4 Policy.
2. Select a policy.
3. Click the Edit icon.
4. Under the heading Security Profiles toggle the button next to Application Control to enable the feature.
5. In the drop down menu field next to the Application Control select the application sensor you wish to apply to

the policy.
6. Select OK.

Creating a new custom application signature

If you have to deal with an application that is not already in the Application List you have the option to create a
new application signature.
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1. Go to Security Profiles > Application Control.
2. Select the link in the upper right corner, [View Application Signatures]
3. Select the Create New icon
4. Give the new signature a name (no spaces) in the Name field.
5. Enter a brief description in the Comments field
6. Enter the text for the signature in the signature field. Use the rules found under Custom IPS signature to

determine syntax.
7. Select OK.

You can configure rate based application control signatures in the CLI Console using
similar IPS signature rate CLI commands.

For more information on this and the CLI syntax, see IPS signature rate count
threshold on page 2880

Messages in response to blocked applications

Once an Application Control sensor has been configured to block a specified application and applied to a policy it
would seem inevitable that at some point an application will end up getting blocked, even if it is only to test the
functionality of the control. When this happens, the sensor can be set to either display a message to offending
user or to just block without any notification. The default setting is to display a message. Setting this up is done in
the CLI.

config application list
edit <name of the sensor>

set app-replacemsg {enable | disable}
end

When blocking applications, there is no replacement message for SSL traffic
with certificate inspection applied.
When SSL deep inspection is enabled, a replacement message will appear
depending on the protocol. For example, with HTTP2, the blocking is done
in the SSL key exchange once the first server packet is delivered and
replacement messages can not be displayed.

P2P application detection

P2P software tends to be evasive. You may be able to enhance P2P application detection by matching patterns
found in the most recent three minutes of P2P traffic to determine if new traffic is P2P. Three minutes is the
length of time information about matched P2P traffic remains in shared memory.

For example, the CLI commands below will result in the Intrusion Prevention System (IPS) looking for patterns
formed by Skype traffic.

config application list
edit <app_list_str>

set p2p-black-list skype
end

end
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Application Control actions

Allow

This action allows the targeted traffic to continue on through the FortiGate unit.

Monitor

This action allows the targeted traffic to continue on through the FortiGate unit but logs the traffic for analysis.

Block

This action prevents all traffic from reaching the application and logs all occurrences.

Quarantine

This action allows you to quarantine or block access to an application for a specified duration that can be entered
in days, hours, and minutes. The default is 5 minutes.

View Signatures

This option brings up a window that displays a list of the signatures with the following columns:

l Name
l Category
l Technology - Technology is broken down into 3 technology models as well as the more basic Network-Protocol

which would can be used as a catch all for anything not covered by the more narrowly defined technologies of:
l Browser-Based
l Client-Server
l Peer-to-Peer

l Popularity - Popularity is broken down into 5 levels of popularity represented by stars.
l Risk - The Risk property does not indicate the level of risk but the type of impact that is likely to occur by allowing

the traffic from that application to occur.

Traffic Shaping

Prior to the release of FortiOS 5.4.0, application control traffic shaping was configured in the Security Profiles >
Application Control interface. There is now a specific section for traffic shaping policies in Policy & Objects
> Traffic Shaping Policy. See Traffic shaping methods in the chapter on Traffic Shaping for details

Application considerations
Some applications behave differently from most others. You should be aware of these differences before using
application control to regulate their use.

IM applications

IM applications are controlled by either permitting or denying the users from logging in to the service. Individual
IM accounts are configured as to whether or not they are permitted and then there is a global policy for how to
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action unknown users, by the application and whether to add the user to the black list or the white list. IM
applications fall under the Collaboration category in the application signature database.

Skype

Based on the NAT firewall type, Skype takes advantage of several NAT firewall traversal methods, such as STUN
(Simple Traversal of UDP through NAT), ICE (Interactive Connectivity Establishment) and TURN (Traversal Using
Relay NAT), to make the connection.

The Skype client may try to log in with either UDP or TCP, on different ports, especially well-known service ports,
such as HTTP (80) and HTTPS (443), because these ports are normally allowed in firewall settings. A client who
has previously logged in successfully could start with the known good approach, then fall back on another
approach if the known one fails.

The Skype client could also employ Connection Relay. This means if a reachable host is already connected to the
Skype network, other clients can connect through this host. This makes any connected host not only a client but
also a relay server.

SPDY

SPDY (pronounced speedy, it’s a trademarked name not an acronym) is a networking protocol developed to
increase the speed and security of HTML traffic. It was developed primarily by Google. The Application Control
engine recognizes this protocol and its required SSL/TLS component within Application Control sensors. It is
counted as part of application traffic for Google and other sources that use the protocol.

Application control monitor
The application monitor enables you to gain insight into the applications generating traffic on your network. When
monitor is enabled in an application sensor entry and that security profile is selected in a security policy, all the
detected traffic required to populate the selected charts is logged to the SQL database on the FortiGate unit hard
drive. The charts are available for display in the Applications section of the FortiViewmenu.

Because the application monitor relies on an SQL database, the feature is available
only on FortiGate units with an internal hard drive.

Application monitor data is stored on the hard drive and restarting the system does not affect the stored monitor
data.

Application control data is available in Log & Report, if enabled.

Application control examples
The scenarios below provide a better understanding of how to implement Application Control and give some
ideas as to why it would be used.

l Blocking instant messaging
l Allowing only software updates
l Blocking Windows XPwith a custom signature
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Blocking instant messaging

Instant messaging use is not permitted at the Example Corporation. Application control helps enforce this policy.

The configuration steps outlined below are for FortiGate's operating in proxy-based inspection and flow-based
inspection with profile-based NGFWmodes. For FortiGate's operating in NGFW policy-based mode, see
Enabling application control in NGFW policy-based mode.

Steps in this process

1. First you will create an application sensor with a single entry that monitors the category that includes instant
messaging applications. You will set the list action toMonitor.

2. Next you will assign the sensor to a policy.
3. Then you will identify the IM applications being used on your network and modify the application sensor to Block

use of those messaging applications

To create the application sensor

1. Go to Security Profiles > Application Control.
2. Select the Create New icon in the title bar of the Edit Application Sensor window.
3. In the Name field, enter no_IM for the application sensor name.
4. If the Collaboration category is not already set toMonitor, then left-click on the icon next to that category and

select Monitor from the dropdown menu.
5. Select OK to save the new sensor.

To enable application control and select the application sensor

1. Go to Policy & Objects > IPv4 Policy.
2. Select the security policy that allows the network users to access the Internet and choose Edit.
3. Under the heading Security Profiles toggle the button next to Application Control to turn it on.
4. In the drop down menu field next to the Application Control select the no_IM application sensor.
5. To inspect all traffic, SSL/SSH inspectionmust be set to deep-inspection profile.
6. Select OK.

To identify IM applications in use on your network

1. Go to FortiView > Applications.
2. Select a time period from the options in the upper-right corner of the window and examine the list of applications.
3. Identify any IM applications you wish to block.

To block IM applications in use on your network

1. Go to Security Profiles > Application Control and edit the no_IM application sensor.
2. Under Application Overrides, click on Add Signatures.
3. Filter byName and select the IM applications you wish to block.
4. Click on Use Selected Signatures.
The selected application will appear under Application Overrides and the action will be set to Block.

5. Select Apply.
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The IM applications identified will be blocked by the security policy that has the no IM application sensor applied
to it. If other firewall policies handle traffic that users could use for applications in the same category, enable
application control with the no IM application sensor for those policies as well.

Allowing only software updates

Some departments at Example Corporation do not require access to the Internet to perform their duties.
Management therefore decided to block their Internet access. Software updates quickly became an issue
because automatic updates will not function without Internet access and manual application of updates is time-
consuming.

The solution is configuring application control to allow only automatic software updates to access the Internet.

The configuration steps outlined below are for FortiGate's operating in proxy-based inspection and flow-based
inspection with profile-based NGFWmodes. For FortiGate's operating in NGFW policy-based mode, see
Enabling application control in NGFW policy-based mode.

To create an application sensor — GUI

1. Go to Security Profiles > Application Control.
2. Select the Create New icon in the title bar of the Edit Application Sensor window.
3. In the Name field, enter Updates_Only as the application sensor name.
4. Using the left-click and drop down on the items in the Category list.

a. Select Monitor from the dropdown menu.

b. Select Block for the rest of the categories.
5. Select OK.

To create an application sensor — CLI

config application list
edit Updates_Only

config entries
edit 1

set category 17
set action pass

end
set other-application-action block
set unknown-application-action block

end

You will notice that there are some differences in the naming convention between the
GUI and the CLI. For instance the Action in the CLI is “pass” and the Action in the
GUI is “Monitor”.

Selecting the application sensor in a security policy

An application sensor directs the FortiGate unit to scan network traffic only when it is selected in a security policy.
When an application sensor is selected in a security policy, its settings are applied to all the traffic the security
policy handles.
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To select the application sensor in a security policy — GUI

1. Go to Policy & Objects > IPv4 Policy.
2. Select a policy.
3. Select the Edit icon.
4. Under the heading Security Profiles toggle the button next to Application Control to turn it on.
5. In the drop down menu field next to the Application Control select the Updates_only list.
6. Select OK.

To select the application sensor in a security policy — CLI

config firewall policy
edit 1

set utm-status enable
set profile-protocol-options default
set application-list Updates_Only

end

Traffic handled by the security policy you modified will be scanned for application traffic. Software updates are
permitted and all other application traffic is blocked.

Blocking Windows XP with a custom signature

In this example, you will use application control to block web traffic from PCs running Windows operating systems
NT 5, including Windows XP and Windows Server 2003 (includesWindows virtual machines).

When a computer’s operating system lacks vendor support, it becomes a threat to the network because newly
discovered exploits will not be patched. Using the FortiGate application control feature, you can restrict these
computers from accessing external resources.

This example will only block web traffic from computers running the affected operating systems. If you wish to
block these computers from being on the network entirely, further  action will be necessary. However, the logs
generated can be used to identify the computers you wish to block.

1. Go to System > Feature Select. Enable Application Control and Apply your changes.
2. Go to Security Profiles >  Application Control and select View Application Signatures.
3. Create a new signature with the syntax below. You can copy and paste the text into the Signature field. Name the

signature Block-Windows-NT5.
F-SBID(--attack_id 8055;--vuln_id 8055;--name
"Windows.NT.5.Web.Surfing";--flow from_client;--pattern !"FCT";--
pattern "Windows NT 5.";--no_case;--context header;--weight 40;--
service HTTP;--protocol tcp;--app_cat 25;--default_action drop_
session;)

If you do not include keyword / value pairs for --attack_id or --vuln_ID in the signature, the
FortiGate will automatically assign values.

The signature will appear at the top of the application list and be listed in theWeb.Client category.

4. Go to Security Profiles > Application Control and edit the default policy.
5. UnderApplication Overrides, select Add Signatures. The new signature should appear at the top of the list. If

it does not, search for the signature’s name.
6. Select the signature, then select Use Selected Signatures.
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7. Go to Policy & Objects > IPv4 Policy and edit the policy that allows connections from the internal network to
the Internet.

8. Under Security Profiles, turn on Application Control and use the default profile.

Results

When a PC running one of the affected operating systems attempts to connect to the Internet using a browser, a
blocked message appears. Because Application Control uses flow-based inspection, if you apply an additional
security profile to your traffic that is proxy-based, the connection will simply timeout rather than display the
replacement message. However, Application Control will still function.

PCs running other operating systems, including later versions of Windows, are not affected.

Go to FortiView > All Sessions and select the 5 minutes view.

Filter the results to show sessions that were blocked.

You will see that the Application Control signature, shown in the Application Name column, was used to block
traffic from PCs running older Windows versions.

For further reading, see Custom Application & IPS Signatures.
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The FortiOS Intrusion Prevention System (IPS) combines signature detection and prevention with low latency and
excellent reliability. With intrusion protection, you can create multiple IPS sensors, each containing a complete
configuration based on signatures. Then, you can apply any IPS sensor to any security policy.

This section describes how to configure the FortiOS Intrusion Prevention settings.

If you enable virtual domains (VDOMs) on the FortiGate unit, intrusion prevention is configured separately for
each virtual domain.

This Handbook chapter includes Inside FortiOS: Intrusion Prevention System providing readers an overview of
the features and benefits of key FortiOS 5.6 components. For readers needing to delve into greater detail, we
provide the following:

IPS concepts
The FortiOS Intrusion Prevention System (IPS) protects your network from outside attacks. Your FortiGate unit
has two techniques to deal with these attacks: anomaly- and signature-based defense.

Anomaly-based defense

Anomaly-based defense is used when network traffic itself is used as a weapon. A host can be flooded with far
more traffic than it can handle, making the host inaccessible. The most common example is the denial of service
(DoS) attack, in which an attacker directs a large number of computers to attempt normal access of the target
system. If enough access attempts are made, the target is overwhelmed and unable to service genuine users.
The attacker does not gain access to the target system, but it is not accessible to anyone else.

The FortiGate DoS feature will block traffic above a certain threshold from the attacker and allow connections
from other legitimate users. The DoS policy configuration can be found in the Firewall chapter of the Handbook.

Access control lists in DoS Policies

This feature allows you to define a list of IPs/subnets/ranges in a DoS policy, and block those IPs from sending
any traffic, by way of an ACL (access control list). The ACL looks similar to a firewall policy, but only checks
source IP, destination IP, destination port, and protocol. To configure in the GUI, go to Policy & Objects > IPv4
Access Control List and create a new policy. Enter the incoming interface, the source address, the destination
address, the services impacted, and, optionally, enter a comment.

CLI Syntax

config firewall acl
edit 1

set interface "port1"
set srcaddr "google-drive"
set dstaddr "all"
set service "ALL"

next
end
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Signature-based defense

Signature-based defense is used against known attacks or vulnerability exploits. These often involve an attacker
attempting to gain access to your network. The attacker must communicate with the host in an attempt to gain
access and this communication will include particular commands or sequences of commands and variables. The
IPS signatures include these command sequences, allowing the FortiGate unit to detect and stop the attack.

Signatures

IPS signatures are the basis of signature-based intrusion prevention. Every attack can be reduced to a particular
string of commands or a sequence of commands and variables. Signatures include this information so your
FortiGate unit knows what to look for in network traffic.

Signatures also include characteristics about the attack they describe. These characteristics include the network
protocol in which the attack will appear, the vulnerable operating system, and the vulnerable application.

To view the complete list of signatures, go to Security Profiles > Intrusion Prevention, and select View IPS
Signatures. This will include the predefined signatures and any custom signatures that you may have created.

With the release of FortiOS 5.6, the IPS signatures list page shows which IPS package is currently deployed.
Users can also change their IPS package by hovering over the information icon next to the IPS package name.
Text will appear that links directly to the FortiGate'sSystem > FortiGuard page from the IPS Signatures list
page.

Protocol decoders

Before examining network traffic for attacks, the IPS engine uses protocol decoders to identify each protocol
appearing in the traffic. Attacks are protocol-specific, so your FortiGate unit conserves resources by looking for
attacks only in the protocols used to transmit them. For example, the FortiGate unit will only examine HTTP
traffic for the presence of a signature describing an HTTP attack.

IPS engine

Once the protocol decoders separate the network traffic by protocol, the IPS engine examines the network traffic
for the attack signatures.

IPS sensors

The IPS engine does not examine network traffic for all signatures. You must first create an IPS sensor and
specify which signatures are included. Add signatures to sensors individually using signature entries, or in groups
using IPS filters.

To view the IPS sensors, go to Security Profiles > Intrusion Prevention.

You can group signatures into IPS sensors for easy selection when applying to firewall policies. You can define
signatures for specific types of traffic in separate IPS sensors, and then select those sensors in profiles designed
to handle that type of traffic. For example, you can specify all of the web-server related signatures in an IPS
sensor, and that sensor can then be applied to a firewall policy that controls all of the traffic to and from a web
server protected by the unit.

The FortiGuard Service periodically updates the pre-defined signatures, with signatures added to counter new
threats. Since the signatures included in filters are defined by specifying signature attributes, new signatures
matching existing filter specifications will automatically be included in those filters. For example, if you have a
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filter that includes all signatures for the Windows operating system, your filter will automatically incorporate new
Windows signatures as they are added.

Each IPS sensor consists of two parts: filters and overrides. Overrides are always checked before filters.

Each filter consists of a number of signatures attributes. All of the signatures with those attributes, and only those
attributes, are checked against traffic when the filter is run. If multiple filters are defined in an IPS Sensor, they
are checked against the traffic one at a time, from top to bottom. If a match is found, the unit takes the
appropriate action and stops further checking.

A signature override can modify the behavior of a signature specified in a filter. A signature override can also add
a signature not specified in the sensor’s filters. Custom signatures are included in an IPS sensor using overrides.

The signatures in the overrides are first compared to network traffic. If the IPS sensor does not find any matches,
it then compares the signatures in each filter to network traffic, one filter at a time, from top to bottom. If no
signature matches are found, the IPS sensor allows the network traffic.

The signatures included in the filter are only those matching every attribute specified. When created, a new filter
has every attribute set to all which causes every signature to be included in the filter. If the severity is changed to
high, and the target is changed to server, the filter includes only signatures checking for high priority attacks
targeted at servers.

IPS filters

IPS sensors contain one or more IPS filters. A filter is a collection of signature attributes that you specify. The
signatures that have all of the attributes specified in a filter are included in the IPS filter.

For example, if your FortiGate unit protects a Linux server running the Apache web server software, you could
create a new filter to protect it. By settingOS to Linux, and Application to Apache, the filter will include only
the signatures that apply to both Linux and Apache. If you wanted to scan for all the Linux signatures and all the
Apache signatures, you would create two filters, one for each.

To view the filters in an IPS sensor, go to Security Profiles > Intrusion Prevention, select the IPS sensor
containing the filters you want to view, and select Edit.

Custom/predefined signature entries

Signature entries allow you to add an individual custom or predefined IPS signature. If you need only one
signature, adding a signature entry to an IPS sensor is the easiest way. Signature entries are also the only way to
include custom signatures in an IPS sensor.

Another use for signature entries is to change the settings of individual signatures that are already included in a
filter within the same IPS sensor. Add a signature entry with the required settings above the filter, and the
signature entry will take priority.

Policies

To use an IPS sensor, you must select it in a security policy or an interface policy. An IPS sensor that it not
selected in a policy will have no effect on network traffic.

IPS is most often configured as part of a security policy. Unless stated otherwise, discussion of IPS sensor use
will be in regards to firewall policies in this document.
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Session timers for IPS sessions

A session time-to-live (TTL) timer for IPS sessions is available to reduce synchronization problems between the
FortiOS Kernel and IPS, and to reduce IPS memory usage. The timeout values can be customized.

Enabling IPS scanning
Enabling IPS scanning involves two separate features of FortiOS 5.6:

l The security policy allows certain network traffic based on the sender, receiver, interface, traffic type, and time of
day. Firewall policies can also be used to deny traffic, but those policies do not apply to IPS scanning.

l The IPS sensor contains filters, signature entries, or both. These specify which signatures are included in the IPS
sensor.

When IPS is enabled and an IPS sensor is selected in a security policy, and all network traffic matching the policy
will be checked for the signatures in the IPS sensor.

General configuration steps

For best results in configuring IPS scanning, follow the procedures in the order given. Also, note that if you
perform any additional actions between procedures, your configuration may have different results.

1. Create an IPS sensor.
2. Add signatures and /or filters.

These can be:
l Pattern based
l Rate based
l Customized

3. Optionally enable blocking malicious URLs.
4. Optionally enable Botnet C&C protection.
5. Select a security policy or create a new one.
6. In the security policy, turn on IPS, and choose the IPS sensor from the list.
All the network traffic controlled by this security policy will be processed according to the settings in the policy.
These settings include the IPS sensor you specify in the policy.

Creating an IPS sensor

You need to create an IPS sensor before specific signatures or filters can be chosen. The signatures can be
added to a new sensor before it is saved. However, it is good practice to keep in mind that the sensor and its
included filters are separate things, and that they are created separately.

To create a new IPS sensor

1. Go to Security Profiles > Intrusion Prevention.
2. Select the Create New icon in the top of the Edit IPS Sensor window.
3. Enter the name of the new IPS sensor.
4. Optionally, enter a comment. The comment will appear in the IPS sensor list.
5. Optionally enable Block malicious URLs and set Botnet C&C protection to Block orMonitor.
6. Select OK.
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A newly created sensor is empty and contains no filters or signatures. You need to add one or more filters or
signatures before the sensor will be of any use.

Blocking Malicious URLs

To use this IPS signature to block malicious URLs, select Block malicious URLs. This feature uses a local
malicious URL database on the FortiGate to assist in drive-by exploits detection. The database contains all
malicious URLs active in the last one month, and all drive-by exploit URLs active in the last three months. The
number of URLs controlled are in the one million range.

Adding IPS signatures to a sensor

1. Go to Security Profiles > Intrusion Prevention.
2. Select the IPS sensor to which you want to add the signature using the drop-down list in the top row of the Edit IPS

Sensor window or by going to the list window.
3. Under IPS Signatures, select Add Signatures.
4. Select one or more signatures from the list and select Use Selected Signatures to add them to the sensor.
5. Optionally right-click on each signature to change the Action (Pass, Monitor, Block, Reset, Default or

Quarantine) and enable or disable Packet Logging.

Adding an IPS filter to a sensor

While individual signatures can be added to a sensor, a filter allows you to add multiple signatures to a sensor by
specifying the characteristics of the signatures to be added.

To create a new Pattern Based Signature and Filter

1. Go to Security Profiles > Intrusion Prevention.
2. Select the IPS sensor to which you want to add the filter using the drop-down list in the top row of the Edit IPS

Sensor window or by going to the list window.
3. Under IPS Filters, select Add Filter.
4. Configure the filter that you require. Signatures matching all of the characteristics you specify in the filter will be

included in the filter. Once finished, select Use Filters.

Application refers to the application affected by the attack and filter options include over 25 applications.

OS refers to the Operating System affected by the attack. The options include BSD, Linux, MacOS, Other,
Solaris, andWindows.

Protocol refers to the protocol that is the vector for the attack; filter options include over 35 protocols, including
"other."

Severity refers to the level of threat posed by the attack. The options include Critical, High, Medium, Low,
and Info.

Target refers to the type of device targeted by the attack. The options include client and server.

5. Once you have selected the filters you wish to add, right-click the filters and choose an action for when a signature
is triggered:

2874 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Intrusion prevention

Action Description

Pass Select Pass to allow traffic to continue to its destination.

Note: to see what the default for a signature is, go to the IPS Signatures page and
enable the column Action, then find the row with the signature name in it.

Monitor Select Monitor to allow traffic to continue to its destination and log the activity. The
log will appear under Log & Report but will only be visible in the GUI in the event of an
intrusion.

Block Select Block to drop traffic matching any the signatures included in the filter.

Reset Select Reset to reset the session whenever the signature is triggered. In the CLI this
action is referred to as Reject.

Default Select Default to use the default action of the signature.

Quarantine The quarantine based on the attacker’s IP Address - Traffic from the Attacker’s IP
address is refused until the expiration time from the trigger is reached. You may set
theQuarantine Duration to any number of Days, Hours, orMinutes.

Packet Logging Select to enable packet logging for the filter.

When you enable packet logging on a filter, the unit saves a copy of the packets that
match any signatures included in the filter. The packets can be analyzed later.

For more information about packet filtering, see "Configuring packet logging options".

6. Select Apply.
The filter is created and added to the filter list.

Adding Rate Based Signatures

These are a subset of the signatures that are found in the database that are normally set to monitor. This group
of signatures is for vulnerabilities that are normally only considered a serious threat when the targeted
connections come in multiples, a little like DoS attacks.

Adding a rate based signature is straight forward. Select the enable button in the Rate Based Signature table that
corresponds with the desired signature.

Customized signatures

Customized signatures must be created before they can be added to the sensor. To get more details on
customized signatures check the Custom Application & IPS Signatures chapter.

Botnet C&C protection

You can set Botnet C&C protection to Block outgoing connections to Botnet sites or just record log messages
(Monitor) when an outgoing Botnet connection attempt is detected.
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The latest botnet database is available from FortiGuard. To see the version of the database and display its
contents, go to System > FortiGuard and view the lists for Botnet IPs and Botnet Domains. You can look up
more details about Botnet IPs and Domains on the FortiGuard site.

Updating predefined IPS signatures

The FortiGuard Service periodically updates the predefined signatures and adds new signatures to counter
emerging threats as they appear.

To ensure that your system is providing the most protection available, these updates can be scheduled as often
as on an hourly basis. To configure this feature, go to System > FortiGuard. UnderAntiVirus & IPS Updates,
enable Scheduled Updates. From here you can set the updates to occur on a consistent weekly, daily, or even
hourly basis.

Because the signatures included in filters are defined by specifying signature attributes, new signatures matching
existing filter specifications will automatically be included in those filters. For example, if you have a filter that
includes all signatures for the Windows operating system, your filter will automatically incorporate newWindows
signatures as they are added.

Viewing and searching predefined IPS signatures

Go to Security Profiles > Intrusion Prevention.Select [View IPS Signatures] to view the list of existing IPS
signatures. You may find signatures by paging manually through the list, apply filters, or by using the search field.

Searching manually

Signatures are displayed in a paged list, with 50 signatures per page. The bottom of the screen shows the current
page and the total number of pages. You can enter a page number and press enter, to skip directly to that page.
Previous Page and Next Page buttons move you through the list, one page at a time. The First Page and Last
Page button take you to the beginning or end of the list.

Searching CVE-IDs

ACVE-ID column displaying CVE-IDs can be optionally added to the IPS Signatures list, however the column is
only available if the IPS package contains CVE-IDs for signatures. CVE-IDs can be numerically filtered by
selecting the CVE-ID column's arrows.

Applying filters

You can enter criteria for one of more columns, and only the signatures matching all the conditions you specify
will be listed.

To apply filters

1. Go to Security Profiles > Intrusion Prevention. Select [View IPS Signatures] .
2. Select column by which to filter.
3. Select the funnel/filter icon and enter the value or values to filter by.
4. Use additional columns as needed to refine search.
The available options vary by column. For example, Enable allows you to choose between two options, while OS
has multiple options, and you may select multiple items together. Filtering by name allows you to enter a text
string and all signature names containing the string will be displayed.

2876 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Intrusion prevention

IPS processing in an HA cluster
IPS processing in an HA cluster is no different than with a single FortiGate unit, from the point of view of the
network user. The difference appears when a secondary unit takes over from the primary, and what happens
depends on the HAmode.

Active-passive

In an active-passive HA cluster, the primary unit processes all traffic just as it would in a stand-alone
configuration. Should the primary unit fail, a secondary unit will assume the role of the primary unit and begin to
process network traffic. By default, the state of active communication sessions are not shared with secondary
units and will not survive the fail-over condition. Once the sessions are reestablished however, traffic processing
will continue as normal.

If your network requires that active sessions are taken over by the new primary unit, select Enable Session
Pick-up in your HA configuration. Because session information must be sent to all subordinate units on a regular
basis, session pick-up is a resource-intensive feature and is not enabled by default.

Active-active

The fail-over process in an active-active cluster is similar to an active-passive cluster. When the primary unit fails,
a secondary unit takes over and traffic processing continues. The load-balancing schedule used to distribute
sessions to the cluster members is used by the new primary unit to redistribute sessions among the remaining
subordinate units. If session pick-up is not enabled, the sessions active on the failed primary are lost, and the
sessions redistributed among the secondary units may also be lost. If session pick-up is enabled, all sessions are
handled according to their last-known state.

Configure IPS options
The following IPS configuration options are available:

l Malicious URL database for drive-by exploits detection
l Customizable replacement message when IPS blocks traffic
l Hardware Acceleration
l Extended IPS Database
l Configuring the IPS engine-count
l Configuring fail-open
l Configuring the session count accuracy
l Configuring IPS intelligence
l Configuring the IPS buffer size
l Configuring protocol decoders
l Configuring security processing modules
l IPS signature rate count threshold

Malicious URL database for drive-by exploits detection

This feature uses a local malicious URL database on the FortiGate to assist in drive-by exploits detection. The
database contains all malicious URLs active in the last one month, and all drive-by exploit URLs active in the last
three months. The number of URLs controlled are in the one million range.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2877



Intrusion prevention

CLI Syntax

config ips sensor
edit <profile>

set block-malicious-url [enable | disable]
next

end

Customizable IPS replacement messages for explicit proxy traffic

If you have enabled IPS in an explicit web proxy policy, you can edit a replacement message that will appear if an
IPS sensor blocks internet access. Go to System > Replacement Messages, select Extended View and find
IPS Sensor Block Page under the Security heading.

Hardware Acceleration for flow-based security profiles (NTurbo and IPSA)

Some FortiGate models support a feature call NTurbo that can offload flow-based firewall sessions to NP4 or
NP6 network processors. Some FortiGate models also support offloading enhanced pattern matching for flow-
based security profiles to CP8 or CP9 content processors. You can use the following command to configure
NTurbo and IPSA:

config ips global
set np-accel-mode {none | basic}
set cp-accel-mode {none | basic | advanced}

end

If the np-accel-mode option is available, your FortiGate supports NTurbo: none disables NTurbo and basic
(the default) enables NTurbo. If the cp-accel-mode option is available your FortiGate supports IPSA: none
disables IPSA, basic enables basic IPSA and advanced enables enhanced IPSAwhich can offload more types
of pattern matching than basic IPSA. advanced is only available on FortiGate models with two or more CP8
processors or one or more CP9 processors.

See the Hardware Acceleration handbook chapter for more information about NTurbo and IPSA.

Extended IPS Database

Some models have access to an extended IPS Database. The extended database may affect the performance of
the FortiGate unit so depending on the model of the FortiGate unit the extended database package may not be
enabled by default. For example, the D-series Desktop model have this option disabled by default.

This feature can only be enbled through the CLI.

config ips global
set database extended

end

Configuring the IPS engine-count

FortiGate units with multiple processors can run more than one IPS engine concurrently. The engine-count
CLI command allows you to specify how many IPS engines are used at the same time:

config ips global
set engine-count <int>

end

The recommended and default setting is 0, which allows the FortiGate unit to determine the optimum number of
IPS engines.
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Configuring fail-open

IPS is likely more important to your network than uninterrupted flow of network traffic, so the fail-open behaviour
of the IPS engine is disabled by default. If you would like to enable the fail-open option, use the following syntax.
When enabled, if the IPS engine fails for any reason, it will fail open. This applies for inspection of all the
protocols inspected by FortiOS IPS protocol decoders, including but not limited to HTTP, HTTPS, FTP, SMTP,
POP3, IMAP, etc. This means that traffic continues to flow without IPS scanning. To enable:

config ips global
set fail-open {enable | disable}

end

The default setting is disable.

Configuring the session count accuracy

The IPS engine can keep track of the number of open session in two ways. An accurate count uses more
resources than a less accurate heuristic count.

config ips global
set session-limit-mode {accurate | heuristic}

end

The default is heuristic.

Configuring IPS intelligence

Starting with FortiOS 5.2, intelligent-mode is a new adaptive detection method. This command is enabled
the default and it means that the IPS engine will perform adaptive scanning so that, for some traffic, the
FortiGate can quickly finish scanning and offload the traffic to NPU or kernel. It is a balanced method which could
cover all known exploits. When disabled, the IPS engine scans every single byte.

config ips global
set intelligent-mode {enable|disable}

end

Configuring the IPS buffer size

Set the size of the IPS buffer.

config ips global
set socket-size <int>

end

The acceptable range is from 1 to 64 megabytes. The default size varies by model. In short, socket-size
determines how much data the kernel passes to the IPS engine each time the engine samples packets.

Configuring protocol decoders

The FortiGate Intrusion Prevention system uses protocol decoders to identify the abnormal traffic patterns that
do not meet the protocol requirements and standards. For example, the HTTP decoder monitors traffic to identify
any HTTP packets that do not meet the HTTP protocol standards.

To change the ports a decoder examines, you must use the CLI. In this example, the ports examined by the DNS
decoder are changed from the default 53 to 100, 200, and 300.

config ips decoder dns_decoder
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set port_list "100,200,300"
end

You cannot assign specific ports to decoders that are set to auto by default. These decoders can detect their
traffic on any port. Specifying individual ports is not necessary.

Configuring security processing modules

FortiGate Security Processing Modules, such as the CE4, XE2, and FE8, can increase overall system
performance by accelerating some security and networking processing on the interfaces they provide. They also
allow the FortiGate unit to offload the processing to the security module, thereby freeing up its own processor for
other tasks. The security module performs its own IPS and firewall processing, but you can configure it to favor
IPS in hostile high-traffic environments.

If you have a security processing module, use the following CLI commands to configure it to devote more
resources to IPS than firewall. This example shows the CLI commands required to configure a security module in
slot 1 for increased IPS performance.

config system amc-slot
edit sw1

set optimization-mode fw-ips
set ips-weight balanced
set ips-p2p disable
set ips-fail-open enable
set fp-disable none
set ipsec-inb-optimization enable
set syn-proxy-client-timer 3
set syn-proxy-server-timer 3

end

In addition to offloading IPS processing, security processing modules provide a hardware accelerated SYN proxy
to defend against SYN flood denial of service attacks. When using a security module, configure your DoS
anomaly check for tcp_syn_flood with the Proxy action. The Proxy action activates the hardware
accelerated SYN proxy.

IPS signature rate count threshold

The IPS signature threshold can allow configuring a signature so that it will not be triggered until a rate count
threshold is met. This provides a more controlled recording of attack activity. For example, if multiple login
attempts produce a failed result over a short period of time then an alert would be sent and perhaps traffic
blocked. This would be a more rational response than sending an alert every time a login failed.

The syntax for this configuration is as follows:

config ips sensor
edit default

config entries
edit <Filter ID number>

set rule <*id>
set rate-count <integer between 1 - 65535>
set rate-duration <integer between 1 - 65535>

The value of the rate-duration is an integer for the time in seconds.

set rate-mode <continuous | periodical>

The rate-mode refers to how the count threshold is met.
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If the setting is “continuous”, and the action is set to block, as soon as the rate-count is reached the
action is engaged. For example, if the count is 10, as soon as the signature is triggered 10 times the traffic
would be blocked.

If the setting is “periodical”, the FortiGate allows up to the value of the rate-count incidents where the
signature is triggered during the rate-duration. For example, if the rate count is 100 and the duration is 60,
the signature would need to be triggered 100 times in 60 seconds for the action to be engaged.

set rate-track <dest-ip | dhcp-client-mac | dns-domain | none | src-ip>

This setting allows the tracking of one of the protocol fields within the packet.

Enabling IPS packet logging
Packet logging saves the network packets containing the traffic matching an IPS signature to the attack log. The
FortiGate unit will save the logged packets to wherever the logs are configured to be stored, whether memory,
internal hard drive, a FortiAnalyzer unit, or the FortiGuard Analysis and Management Service.

You can enable packet logging in the filters. Use caution in enabling packet logging in a filter. Filters configured
with few restrictions can contain thousands of signatures, potentially resulting in a flood of saved packets. This
would take up a great deal of space, require time to sort through, and consume considerable system resources to
process. Packet logging is designed as a focused diagnostic tool and is best used with a narrow scope.

Although logging to multiple FortiAnalyzer units is supported, packet logs are not sent
to the secondary and tertiary FortiAnalyzer units. Only the primary unit receives packet
logs.

To enable packet logging for a filter

1. Create a filter in an IPS sensor.
2. After creating the filter, right-click the filter, and select Enable in the Packet Logging column of the filter table.
3. Select the IPS sensor in the security policy that allows the network traffic the FortiGate unit will examine for the

signature.
For information on viewing and saving logged packets, see Configuring packet logging options below.

IPS logging changes

IPS operations severely affected by disk logging are moved out of the quick scanning path, including logging,
SNMP trap generation, quarantine, etc.

Scanning processes are dedicated to nothing but scanning, which results in more evenly distributed CPU usage.
Slow (IPS) operations are taken care of in a dedicated process, which usually stays idle.

Setting packet-log-history to a value larger than 1 can affect the performance
of the FortiGate unit because network traffic must be buffered. The performance
penalty depends on the model, the setting, and the traffic load.
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Other IPS examples

Configuring basic Intrusion Prevention

Small offices, whether they are small companies, home offices, or satellite offices, often have very simple needs.
This example details how to enable IPS on a FortiGate unit located in a satellite office. The satellite office
contains only Windows clients.

Creating an IPS sensor

Most IPS settings are configured in an IPS sensor. IPS sensors are selected in firewall policies. This way, you can
create multiple IPS sensors, and tailor them to the traffic controlled by the security policy in which they are
selected. In this example, you will create one IPS sensor.

To create an IPS sensor— GUI

1. Go to Security Profiles > Intrusion Prevention.
2. Select the Create New icon in the top of the Edit IPS Sensor window.
3. In the Name field, enter basic_ips.
4. In the Comments field, enter IPS for Windows clients.
5. Select OK.
6. Select the Create New drop-down to add a new component to the sensor and for the Sensor Type choose Filter

Based.
7. In the Filter Options choose the following:

a. For Severity: select all of the options

b. For Target: select Client only.

c. ForOS: selectWindows only.
8. For the Action leave as the default.
9. Select OK to save the filter.
10. Select OK to save the IPS sensor.

To create an IPS sensor — CLI

config ips sensor
edit basic_ips

set comment "IPS for Windows clients"
config entries

edit 1
set location client
set os windows

end
end

end
end
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Selecting the IPS sensor in a security policy

An IPS sensor directs the FortiGate unit to scan network traffic only when it is selected in a security policy. When
an IPS sensor is selected in a security policy, its settings are applied to all the traffic the security policy handles.

To select the IPS sensor in a security policy — GUI

1. Go to Policy & Objects > IPv4 Policy.
2. Select a policy.
3. Select the Edit icon.
4. Enable the IPS option under Security Profiles.
5. Select the preferred IPS sensor from the dropdown menu.
6. Select OK to save the security policy.

To select the IPS sensor in a security policy — CLI

config firewall policy
edit 1

set utm-status enable
set ips-sensor basic_ips

end

The IPS sensor in this example is basic_ips. All traffic handled by the security policy you modified will be
scanned for attacks against Windows clients. A small office may have only one security policy configured. If you
have multiple policies, consider enabling IPS scanning for all of them.

Using IPS to protect your web server

Many companies have web servers and they must be protected from attack. Since web servers must be
accessible, protection is not as simple as blocking access. IPS is one tool your FortiGate unit has to allow you to
protect your network.

In this example, we will configure IPS to protect a web server. As shown below, a FortiGate unit protects a web
server and an internal network. The internal network will have its own policies and configuration but we will
concentrate on the web server in this example.
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A simple network configuration

The FortiGate unit is configured with:

l a virtual IP to give the web server a unique address accessible from the Internet.
l a security policy to allow access to the web server from the Internet using the virtual IP.

To protect the web server using intrusion prevention, you need to create an IPS sensor, populate it with filters,
then enable IPS scanning in the security policy.

To create an IPS sensor

1. Go to Security Profiles > Intrusion Prevention.
2. Select Create New.
3. Enter web_server as the name of the new IPS sensor.
4. Select OK.
The new IPS sensor is created but it has no filters, and therefore no signatures are included.

The web server operating system is Linux, so you need to create a filter for all Linux server signatures.

To create the Linux server filter

1. Go to Security Profiles > Intrusion Prevention.
2. Select the web_server IPS sensor and select the Edit icon.
3. In the Pattern Based Signatures and Filters section, select Create New.
4. For Sensor Type, select Filter Based.
5. For FilterOptions.
6. In the Filter Options choose the following:

a. For Severity: select all of the options

b. For Target: select server only.

c. ForOS: select Linux only.
7. Select OK.
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The filter is saved and the IPS sensor page reappears. In the filter list, find the Linux Server filter and look at the
value in the Count column. This shows how many signatures match the current filter settings. You can select the
View Rules icon to see a listing of the included signatures.

To edit the security policy

1. Go to Policy & Objects > IPv4 Policy select security policy that allows access to the web server, and select the
Edit icon.

2. Enable IPS option and choose the web_server IPS sensor from the list.
3. Select OK.
Since IPS is enabled and the web_server IPS sensor is specified in the security policy controlling the web
server traffic, the IPS sensor examines the web server traffic for matches to the signatures it contains.

Create and test a packet logging IPS sensor

In this example, you create a new IPS sensor and include a filter that detects the EICAR test file and saves a
packet log when it is found. This is an ideal first experience with packet logging because the EICAR test file can
cause no harm, and it is freely available for testing purposes.

Create an IPS senor

1. Go to Security Profiles > Intrusion Prevention.
2. Select Create New.
3. Name the new IPS sensor EICAR_test.
4. Select OK.

Create an entry

1. Select the Create New.
2. For Sensor Type choose Specify Signatures.
3. Rather than search through the signature list, use the name filter by selecting the search icon over the header of

the Signature column.
4. Enter EICAR in the Search field.
5. Highlight the Eicar.Virus.Test.File signature by clicking on it.
6. Select Block as the Action for the EICAR test sensor in the IPS Signatures table.
7. Enable Packet Logging.
8. Select OK to save the IPS sensor.

Add the IPS sensor to the security policy allowing Internet access

1. Go to Policy & Objects > IPv4 Policy.
2. Select the security policy that allows you to access the Internet.
3. Select the Edit icon.
4. Go to Security Profiles and enable IPS and choose EICAR test from the available IPS sensors..
5. Enable Log Allowed Traffic and select All Sessions.
6. Select OK.
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With the IPS sensor configured and selected in the security policy, the FortiGate unit blocks any attempt to
download the EICAR test file.

Test the IPS sensor

1. Using your web browser, go to http://www.eicar.org/anti_virus_test_file.htm.
2. Scroll to the bottom of the page and select eicar.com from the row labeled as using the standard HTTP protocol.
3. The browser attempts to download the requested file and,

l If the file is successfully downloaded, the custom signature configuration failed at some point. Check the
custom signature, the IPS sensor, and the firewall profile.

l If the download is blocked with a high security alert message explaining that you’re not permitted to download
the file, the EICAR test file was blocked by the FortiGate unit antivirus scanner before the IPS sensor could
examine it. Disable antivirus scanning and try to download the EICAR test file again.

l If no file is downloaded and the browser eventually times out, the custom signature successfully detected the
EICAR test file and blocked the download.

Viewing the packet log

1. Go to Log & Report > Forward Traffic.
2. Locate the log entry that recorded the blocking of the EICAR test file block. The Message field data will be

tools: EICAR.AV.Test.File.Download.
3. Select the View Packet Log icon in the Packet Log column.
4. The packet log viewer is displayed.

Configuring a Fortinet Security Processing module

The Example Corporation has a web site that is the target of SYN floods. While they investigate the source of the
attacks, it’s very important that the web site remain accessible. To enhance the ability of the company’s
FortiGate-100D to deal with SYN floods, the administrator will install an ASM-CE4 Fortinet Security Processing
module and have all external access to the web server come though it.

The security processing modules not only accelerate and offload network traffic from the FortiGate unit’s
processor, but they also accelerate and offload security and content scanning. The ability of the security module
to accelerate IPS scanning and DoS protection greatly enhances the defense capabilities of the FortiGate-100D.

Assumptions

As shown in other examples and network diagrams throughout this document, the Example Corporation has a
pair of FortiGate-100D units in an HA cluster. To simplify this example, the cluster is replaced with a single
FortiGate-100D.

An ASM-CE4 is installed in the FortiGate-100D.

The network is configured as shown below.

Network configuration

The Example Corporation network needs minimal changes to incorporate the ASM-CE4. Interface amc-sw1/1 of
the ASM-CE4 is connected to the Internet and interface amc-sw1/1 is connected to the web server.

Since the main office network is connected to port2 and the Internet is connected to port1, a switch is installed to
allow both port1 and amc-sw1/1 to be connected to the Internet.
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The FortiGate-100D network configuration

The switch used to connect port1 and amc-sw1/1 to the Internet must be able to handle any SYN flood, all of the
legitimate traffic to the web site, and all of the traffic to and from the Example Corporation internal network. If the
switch can not handle the bandwidth, or if the connection to the service provider can not provide the required
bandwidth, traffic will be lost.

Security module configuration

The Fortinet security modules come configured to give equal priority to content inspection and firewall
processing. The Example Corporation is using a ASM-CE4 module to defend its web server against SYN flood
attacks so firewall processing is a secondary consideration.

Use these CLI commands to configure the security module in ASM slot 1 to devote more resources to content
processing, including DoS and IPS, than to firewall processing.

config system amc-slot
edit sw1

set optimization-mode fw-ips
set ips-weight balanced
set ips-p2p disable
set ips-fail-open enable
set fp-disable none
set ipsec-inb-optimization enable
set syn-proxy-client-timer 3
set syn-proxy-server-timer 3

end

These settings do not disable firewall processing. Rather, when the security module nears its processing
capacity, it will chose to service content inspection over firewall processing.
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This section describes how to configure FortiGate email filtering for IMAP, POP3, and SMTP email. Email
filtering includes both spam filtering and filtering for any words or files you want to disallow in email messages. If
your FortiGate unit supports SSL content scanning and inspection, you can also configure spam filtering for
IMAPS, POP3S, and SMTPS email traffic.

The Anti-Spam security profile is only available when operating the FortiGate in proxy-based inspection.

The following topics are included in this section:

Anti-Spam concepts
You can configure the FortiGate unit to manage unsolicited commercial email by detecting and identifying spam
messages from known or suspected spam servers.

The FortiGuard Anti-Spam service uses both a sender IP reputation database and a spam signature database,
along with sophisticated spam filtering tools, to detect and block a wide range of spam messages. Using
FortiGuard Anti-Spam profile settings, you can opt to filter with IP address checking, URL checking, email
checksum checking, detection of phishing URLs in email, and spam submission. Updates to the IP reputation and
spam signature databases are provided continuously via the global FortiGuard Distribution Network.

At the FortiGuard Anti-Spam service page on the FortiGuard Labs website, you can find out whether an IP
address is blacklisted in the FortiGuard Anti-Spam IP reputation database, or whether a URL or email address is
in the signature database.

Anti-Spam techniques
The FortiGate unit has a number of techniques available to help detect spam. Some use the FortiGuard Anti-
Spam service and require a subscription. The remainder use your DNS servers or use lists that you must
maintain.

Black white list

These are the types of black white lists available. They include:

l IP/Netmask
The FortiGate unit compares the IP address of the client delivering the email to the addresses in the IP address
black / white list specified in the email filter profile. If a match is found, the FortiGate unit will take the action
configured for the matching black / white list entry against all delivered email.
The default setting of the smtp-spamhdrip CLI command is disable. If enabled, the FortiGate unit will check
all the IP addresses in the header of SMTP email against the specified IP address black / white list.

l Email Wildcard
The FortiGate unit compares the sender email address, as shown in the message header and envelope MAIL
FROM, to the pattern in the patterned field. The wildcard symbol is used in the place of characters in the address
that may vary from the pattern. If a match is found, the FortiGate unit will take the action configured for the
matching black / white list entry.

l Email Regular Expression
The FortiGate unit compares the sender email address, as shown in the message envelope MAIL FROM, to the
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pattern in the patterned field. The regular expression that can be used is much more sophisticated than a simple
wildcard variable. If a match is found, the FortiGate unit will take the action configured for the matching black/white
list entry.

Pattern

The pattern field is for entering the identifying information that will enable the filter to correctly identify the email
messages.

l If the type is IP/Netmask the filter will be an IP address with a subnet mask.
l If the type is Email Wildcard the filter will be an email address with a wildcard symbol in place of the variable

characters. For example *.example.com or fred@*.com.
l If the type is Email Regular Expression, regular expression can be used to create a more granular filter for email

addresses. For example, ^[_a-z0-9-]+(\.[_a-z0-9-]+)*@(example|xmple|examp).(com|org|net) could be used filter
based on a number of combinations of email domain names.

Action

l Tag
If this is the selected action, the email will be allowed through but it will be tagged with an indicator that clearly
marks the email as spam.

l Pass
If this is the selected action, the email will be allowed to go through to its destination on the assumption that the
message is not spam.

l Discard
If this is the selected action, the email will be dropped at the before reaching its destination.

Status

Indicates whether this particular list is enabled or disabled.

Banned word check

When you enable banned word checking, your FortiGate unit will examine the email message for words
appearing in the banned word list specified in the Anti-Spam profile. If the total score of the banned word
discovered in the email message exceeds the threshold value set in the Anti-Spam profile, your FortiGate unit will
treat the message as spam.

When determining the banned word score total for an email message, each banned word score is added once no
matter how many times the word appears in the message. Use the command config spamfilter bword to
add an email banned word list. Use the command config spamfilter profile to add a banned word list
to an Anti-Spam profile.

How content is evaluated

Every time the banned word filter detects a pattern in an email message, it adds the pattern score to the sum of
scores for the message. You set this score when you create a new pattern to block content. The score can be any
number from zero to 99999. Higher scores indicate more offensive content. When the total score equals or
exceeds the threshold, the email message is considered as spam and treated according to the spam action
configured in the email filter profile. The score for each pattern is counted only once, even if that pattern appears
many times in the email message. The default score for banned word patterns is 10 and the default threshold is
10. This means that by default, an email message is blocked by a single match.
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A pattern can be part of a word, a whole word, or a phrase. Multiple words entered as a pattern are treated as a
phrase. The phrase must appear as entered to match. You can also use wildcards or regular expressions to have
a pattern match multiple words or phrases.

For example, the FortiGate unit scans an email message that contains only this sentence: “The score for each
word or phrase is counted only once, even if that word or phrase appears many times in the email message.”

Banned
word pat-
tern

Pattern
type

Assigned
score

Score added to
the sum for the
entire page

Comment

word Wildcard 20 20 The pattern appears twice but multiple
occurrences are only counted once.

word phrase Wildcard 20 0
Although each word in the phrase appears in the
message, the words do not appear together as
they do in the pattern. There are no matches.

word*phrase Wildcard 20 20 The wildcard represents any number of any
character. A match occurs as long as “word”
appears before “phrase” regardless of what is in
between them.

mail*age Wildcard 20 20
Since the wildcard character can represent any
characters, this pattern is a match because
“email message” appears in the message.

In this example, the message is treated as spam if the banned word threshold is set to 60 or less.

Adding words to a banned word list

When you enter a word, set the Pattern-type to wildcards or regular expressions.

Wildcard uses an asterisk (“*”) to match any number of any character. For example, re* will match all words
starting with “re”.

Regular expression uses Perl regular expression syntax. See http://perldoc.perl.org/perlretut.html for detailed
information about using Perl regular expressions.

DNS-based Blackhole List (DNSBL)

ADNSBL is a list of IP addresses, usually maintained by a third party, which are identified as being associated
with spamming.

FortiGuard-Antispam Service.

FortiGuard IP address check

The FortiGate unit queries the FortiGuard Anti-Spam Service to determine if the IP address of the client
delivering the email is blacklisted. Amatch will cause the FortiGate unit to treat delivered messages as spam.

The default setting of the smtp-spamhdrip CLI command is disable. When you enable FortiGuard IP
address checking, your FortiGate unit will submit the IP address of the client to the FortiGuard service for
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checking. If the IP address exists in the FortiGuard IP address black list, your FortiGate unit will treat the
message as spam.

FortiGuard URL check

When you enable FortiGuard URL checking, your FortiGate unit will submit all URLs appearing in the email
message body to the FortiGuard service for checking. If a URL exists in the FortiGuard URL black list, your
FortiGate unit will treat the message as spam.

FortiGuard email checksum check

When you enable FortiGuard email checksum checking, your FortiGate unit will submit a checksum of each email
message to the FortiGuard service for checking. If a checksum exists in the FortiGuard checksum black list, your
FortiGate unit will treat the message as spam.

Detect phishing URLs in email

When you enable FortiGuard phishing URL detection, your FortiGate unit will submit all URL hyperlinks
appearing in the email message body to the FortiGuard service for checking. If a URL exists in the FortiGuard
URL phishing list, your FortiGate unit will remove the hyperlink from the message. The URL will remain in place,
but it will no longer be a selectable hyperlink.

FortiGuard spam submission

Spam submission is a way you can inform the FortiGuard Anti-Spam service of non-spam messages incorrectly
marked as spam. When you enable this setting, the FortiGate unit adds a link to the end of every message
marked as spam. You then select this link to inform the FortiGuard Anti-Spam service when a message is
incorrectly marked.

Trusted IP Addresses

A list of IP addresses that are trusted by the FortiGate is created. Any email traffic coming in from these IP
address will be exempted to perform IP based check, such as DNSBL/RBL, FortiShield SPAM IP or locally defined
IP black list check.

If the FortiGate unit sits behind a company’s Mail Transfer Units, it may be unnecessary to check email IP
addresses because they are internal and trusted. The only IP addresses that need to be checked are those from
outside of the company. In some cases, external IP addresses may be added to the list if it is known that they are
not sources of spam.

MIME header

This feature filters by the MIME header. MIME header settings are configured in a separate part of the command
tree but MIME header filtering is enabled within each profile.

HELO DNS lookup

Whenever a client opens an SMTP session with a server, the client sends a HELO command with the client
domain name. The FortiGate unit takes the domain name specified by the client in the HELO and does a DNS
lookup to determine if the domain exists. If the lookup fails, the FortiGate unit determines that any messages
delivered during the SMTP session are spam.

The HELO DNS lookup is available only for SMTP traffic.
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Return email DNS check

The FortiGate unit performs a DNS lookup on the If no such record exists, the message is treated as spam.

When you enable return email DNS checking, your FortiGate unit will take the domain in the reply-to email
address and reply-to domain and check the DNS servers to see if there is an A or MX record for the domain. If the
domain does not exist, your FortiGate unit will treat the message as spam.

Configuring Anti-Spam
FortiGuard email filtering techniques us FortiGuard services to detect the presence of spam among your email. A
FortiGuard subscription is required to use the FortiGuard email filters. To enable email filtering an email filter
needs to be created and then the filter needs to be associated with a security policy.

The Anti-Spam security profile is only available when operating the FortiGate in proxy-based inspection.

The filter can be created as follows:

l Go to Security Profiles > Anti-Spam.
l Select the Create New icon (a plus symbol in a circle in the upper right hand corner).
l Select the List icon (a page symbol in the upper right hand corner) and in the new window select Create New.

An existing filter can be edited as follows:

l Go to Security Profiles > Anti-Spam.
l Select the filter that you wish to edit from the dropdown menu in the upper right corner.
l Select the List icon (a page symbol in the upper right hand corner) and select the filter that you wish to edit from

the list.

Once you are in the proper Edit Anti-Spam Profilewindow, you can enter a name in the Name field if it’s a new
filter.

The Comments field is for a description or other information that will assist in understanding the function or
purpose of the this particular filter.

Before any of the other features or options of the filter appear the checkbox next to Enable Spam Detection and
Filtering must be checked.

Spam detection by protocol

This matrix includes three rows that represent the email protocols IMAP, POP3 and SMTP.

There are also columns for:

Spam Action

For the client protocols, IMAP and POP3 the options are:

l Tag - This action will insert a tag into the email somewhere so that when the recipients view the email they will be
warned that it is likely a spam.

l Pass - This action will allow any emails marked as spam to pass through without change. If this option is chosen,
the Tag comments will be greyed out.

For the transfer protocol, SMTP, the options are:
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l Tag - This action will insert a tag into the email somewhere so that when the recipients view the email they will be
warned that it is likely a spam.

l Discard - The action will drop the email before it reaches its destination.
l Pass - This action will allow any emails marked as spam to pass through without change. If this option is chosen,

the Tag comments will be greyed out.

Tag Location

l Subject - The contents of the Tag Format will be inserted into the subject line. The subject line is the most
commonly used.

l MIME - The contents of the Tag Format will be inserted in with the MIME header header.

Tag Format

The contents of this field will be entered into the tag location specified. The most common tag is something along
the lines of [Spam] or **SPAM**

FortiGuard Spam Filtering

The options in the section are ones that require a FortiGuard subscription.

The options available in this section, to be selected by checkbox are:

l IP Address Check
l URL Check
l Detect Phishing URLs in Email
l Email Checksum Check
l Spam Submission

Local Spam Filtering

The options in the section are ones can be managed on the local device without the need for a FortiGuard
subscription.

The options available in this section, to be selected by checkbox are:

l HELO DNS Lookup
l Return Email DNSCheck
l BlackWhite List - checking this option will produce a table that can be edited to create a number of black / white

lists that can be separately configured and enabled.

Another local spam filter profile option that can only be configured in the CLI is the bannedword.check. To
configure this, enter the following commands in the CLI:

config spamfilter profile
edit <filter_name>

set options bannedword
set spam-bword-table 1

next
end

See the section on banned word checking for more information on how content is evaluated.
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Order of spam filtering
The FortiGate unit checks for spam using various filtering techniques. The order in which the FortiGate unit uses
these filters depends on the mail protocol used.

Filters requiring a query to a server and a reply (FortiGuard Anti-Spam service and DNSBL/ORDBL) are run
simultaneously. To avoid delays, queries are sent while other filters are running. The first reply to trigger a spam
action takes effect as soon as the reply is received.

Each spam filter passes the email to the next if no matches or problems are found. If the action in the filter is
Mark as Spam, the FortiGate unit tags the email as spam according to the settings in the email filter profile.

For SMTP and SMTPS, if the action isDiscard, the email message is discarded or dropped.

If the action in the filter isMark as Clear, the email is exempt from any remaining filters. If the action in the filter
isMark as Reject, the email session is dropped.

Order of SMTP and SMTPS spam filtering

The FortiGate unit scans SMTP and SMTPS email for spam in a specific order, depending on whether or not the
local override feature has been enabled. By default, local override is disabled on the FortiGate. Enabling local
override will give priority to local spam filters.

You can enable local override with the CLI command set local-override {enable | disable} when
configuring a spamfilter profile. Enable this command to override SMTP or SMTPS remote check, which includes
IP RBL check, IP FortiGuard AntiSpam check and HELO DNS check, with the locally defined black/white
antispam list.

SMTPS spam filtering is available on FortiGate units that support SSL content scanning and inspection.

Enabling local override of Anti-Spam filter

CLI Syntax

config spamfilter profile
edit <filter_name>

set spam-filtering enable
set options spambwl spamfsip spamfsurl spamhelodns spamfsphish
config smtp

set local-override enable
end
set spam-bwl-table 1

next
end

Order of SMTP and SMTPS spam filtering with local-override disabled

1. HELO DNS Lookup, Last Hop IP check against ORDBL
2. Return email DNS check, FortiGuard email checksum check, FortiGuard URL check, FortiGuard IP address check,

Phishing URLs detection
3. Last Hop IP check local black/white list (BWL)
4. Envelope Address check local BWL
5. Headers IPs local BWL
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6. Headers email address local BWL, MIME header checks based on local list of patterns (mheader)
7. Banned words (subject first, then body) based on local BWL (bword)

Order of SMTP and SMTPS spam filtering with local-override enabled

1. Last Hop IP check local black/while list (BWL)
2. Envelope Address check local BWL
3. Headers IPs local BWL, MIME header checks based on local list of patterns (mheader)
4. Headers email address local BWL
5. Banned words (subject first, then body) based on local list of patterns (bword)
6. HELO DNS Lookup, Last Hop IP check against ORDBL
7. Return email DNS check, FortiGuard email checksum check, FortiGuard URL check, FortiGuard IP address

checks, Phishing URLs detection

Order of IMAP, POP3, IMAPS and POP3S spam filtering

The FortiGate unit scans IMAP, POP3, IMAPS and POP3S email for spam in the order given below. IMAPS and
POP3S spam filtering is available on FortiGate units that support SSL content scanning and inspection.

1. MIME headers check, E-mail address BWL check
2. Banned word check on email subject
3. IP BWL check
4. Banned word check on email body
5. Return email DNS check, FortiGuard Antispam email checksum check, FortiGuard Antispam URL check, DNSBL

&ORDBL check.

Spam actions
When spam is detected, the FortiGate unit will deal with it according to the Spam Action setting in the anti-
spam profile. Note that POP3S, IMAPS and SMTPS spam filtering is available only on FortiGate units that
support SSL content scanning and inspection. POP3, IMAP, POP3S and IMAPSmail can only be tagged. SMTP
and SMTPSmail can be set to Discard or Tagged:

Discard

When the spam action is set to Discard, messages detected as spam are deleted. No notification is sent to the
sender or recipient.

Pass

When the spam action is set to Pass, the spam filter is disabled for the related protocol.

Tag

When the spam action is set to Tag, messages detected as spam are labeled and delivered normally. The text
used for the label is set in the Tag Format field and the label is placed in the subject or the message header, as
set with the Tag Location option.
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Anti-Spam examples

Configuring simple Anti-Spam protection

Small offices, whether they are small companies, home offices, or satellite offices, often have very simple needs.
This example details how to enable Anti-Spam protection on a FortiGate unit located in a satellite office.

Creating an email filter profile

Most Anti-Spam settings are configured in an Anti-Spam profile. Anti-Spam profiles are selected in firewall
policies. This way, you can create multiple Anti-Spam profiles, and tailor them to the traffic controlled by the
security policy in which they are selected. In this example, you will create one Anti-Spam profile.

To create an Anti-Spam profile — web-based manager

1. Go to Security Profiles > Anti-Spam.
2. Select the Create New icon in the Edit Anti-Spam Profile window title.
3. In the Name field, enter basic_anti-spam
4. Select Enable Spam Detection and Filtering.
5. Ensure that IMAP, POP3, and SMTP are selected in the header row.

These header row selections enable or disable examination of each Anti-Spam type. When disabled,
the email traffic of that type is ignored by the FortiGate unit and no Anti-Spam options are available.

6. Under FortiGuard Spam Filtering, enable IP Address Check.
7. Under FortiGuard Spam Filtering, enable URL Check.
8. Under FortiGuard Spam Filtering, enable E-mail Checksum Check.
9. Select OK to save the email filter profile.

To create an Anti-Spam profile — CLI

config spamfilter profile
edit basic_anti-spam

set options spamfsip spamfsurl spamfschksum
end

Selecting the Anti-Spam profile in a security policy

An Anti-Spam profile directs the FortiGate unit to scan network traffic only when it is selected in a security policy.
When an Anti-Spam profile is selected in a security policy, its settings are applied to all the traffic the security
policy handles.

To select the Anti-Spam profile in a security policy — web-based manager

1. Go to Policy & Objects > IPv4 Policy.
2. Create a new or edit a policy.
3. Turn on Anti-Spam.
4. Select the basic_anti-spam profile from the list.
5. Select OK to save the security policy.
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To select the Anti-Spam profile in a security policy — CLI

config firewall policy
edit 1

set utm-status enable
set profile-protocol-options default
set spamfilter-profile basic_anti-spam

end

IMAP, POP3, and SMTP email traffic handled by the security policy you modified will be scanned for spam. Spam
messages have the text “Spam” added to their subject lines. A small office may have only one security policy
configured. If you have multiple policies, consider enabling spam scanning for all of them.

Blocking email from a user

Employees of the Example.com corporation have been receiving unwanted email messages from a former client
at a company called example.net. The client’s email address is client@example.net. All ties between the
company and the client have been severed, but the messages continue. The FortiGate unit can be configured to
prevent these messages from being delivered.

To enable Anti-Spam

1. Go to Security Profiles > Anti-Spam.
2. Select the Anti-Spam profile that is used by the firewall policies handling email traffic from the Anti-Spam profile

drop down list.
3. In the row Tag Location, select Subject for all three mail protocols.
4. In the row Tag Format, enter SPAM: in all three fields.

This means that normal spam will be tagged in the subject line.
5. Select Enable Spam Detection and Filtering.
6. Under Local Spam Filtering, enable Black White List and select Create New.
7. In the BlackWhite List widget, select Create New.
8. Select Email Address Wildcard.
9. Enter client@example.net in the Pattern field.

l If you wanted to prevent everyone’s email from the client’s company from getting through you could have used
*@example.net instead.

10. Set the Action asMark as Spam.
11. Set the Status to Enable.
12. Confirm that the SMTP protocol action is set to Discard.
13. Select OK.
Now that the email address list is created, you must enable the email filter in the Anti-Spam profile.

When this Anti-Spam profile is selected in a security policy, the FortiGate unit will reject any email message from
an address ending with @example.net for all email traffic handled by the security policy.
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The FortiGate data leak prevention (DLP) system allows you to prevent sensitive data from leaving your network.
When you define sensitive data patterns, data matching these patterns will be blocked, or logged and allowed,
when passing through the FortiGate unit. You configure the DLP system by creating individual filters based on file
type, file size, a regular expression, an advanced rule, or a compound rule, in a DLP sensor and assign the sensor
to a security policy.

Although the primary use of the DLP feature is to stop sensitive data from leaving your network, it can also be
used to prevent unwanted data from entering your network and to archive some or all of the content passing
through the FortiGate unit.

This section describes how to configure the DLP settings. DLP can only be configured for FortiGate units in proxy-
based inspection.

The following topics are included:

l Data leak prevention concepts
l Enable data leak prevention
l Creating or editing a DLP sensor
l DLP archiving
l DLP examples

Data leak prevention concepts
Data leak prevention examines network traffic for data patterns you define through the use of the GUI and CLI
commands. The DLP feature is broken down into a number of parts. Note, DLP is not available in flow-based
inspection.

DLP sensor

ADLP sensor is a package of filters. To use DLP, you must enable it in a security policy and select the DLP sensor
to use. The traffic controlled by the security policy will be searched for the patterns defined in the filters contained
in the DLP sensor. Matching traffic will be passed or blocked according to how you configured the filters.

DLP filter

Each DLP sensor has one or more filters configured within it. Filters can examine traffic for known files using DLP
fingerprints, for files of a particular type or name, for files larger than a specified size, for data matching a
specified regular expression, or for traffic matching an advanced rule or compound rule.

DLP Filter Actions

You can configure the action taken when a match is detected. The actions include:

l Allow
l Log Only
l Block
l Quarantine IP address

2898 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Data leak prevention

Log Only is enabled by default.

Allow

The FortiGate takes no action, even if the patterns specified in the filter are matched.

Log Only

The FortiGate takes no action on network traffic matching a rule with this action. The filter match is logged.

Block

Traffic matching a filter with the block action will not be delivered. The matching message or download is
replaced with the data leak prevention replacement message.

Quarantine IP Address/ Source IP ban

Starting in FortiOS 5.2, the quarantine, as a place where traffic content was held in storage so it couldn’t interact
with the network or system, was removed. The term quarantine was kept to describe preventing selected source
IPs from interacting with the network and protected systems. This source IP ban is kept in the kernel rather than
in any specific application engine and can be queried by APIs. The features that can use the APIs to access and
use the banned source IP addresses are antivirus, DLP, DoS and IPS. Both IPv4 and IPv6 version are included in
this feature.

If the quarantine-ip action is used, the additional variable of expiry time will become available. This variable
determines for how long the source IP address will be blocked. In the GUI it is shown as a field before minutes. In
the CLI the option is called expiry and the duration is in the format <###d##h##m>. The maximum days value
is 364. The maximum hour value is 23 and the maximum minute value is 59. The default is 5 minutes.

If a DLP sensor has contains a DLP filter with action set to Allow certain files and
another DLP filter with action set to Block those same files, then the order of the
filters within that sensor will determine which action is taken first.

Configuring using the CLI

To configure the DLP sensor to add the source IP address of the sender of a protected file to the quarantine or list
of banned source IP addresses edit the DLP Filter, use these CLI commands:

config dlp sensor
edit <sensor name>

config filter
edit <id number of filter>

set action quarantine-ip
set expiry 5m
end

end

Preconfigured sensors

A number of preconfigured sensors are provided with your FortiGate unit. These can be edited to more closely
match your needs.

Two of the preconfigured sensors with filters ready for you to enable are:
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l Credit-Card - This sensor logs the traffic, both files and messages, that contain credit card numbers in the formats
used by American Express, MasterCard and Visa.

l SSN-Sensor - This sensor logs the traffic, both files and messages, that contain Social Security Numbers with the
exception of those that are WebEx invitation emails.

These rules affect only unencrypted traffic types. If you are using a FortiGate unit that
can decrypt and examine encrypted traffic, you can enable those traffic types in these
rules to extend their functionality if required.

Before using the rules, examine them closely to ensure you understand how they will
affect the traffic on your network.

DLP document fingerprinting

One of the DLP techniques to detect sensitive data is fingerprinting (also called document fingerprinting). Most
DLP techniques rely on you providing a characteristic of the file you want to detect, whether it’s the file type, the
file name, or part of the file contents. Fingerprinting is different in that you provide the file itself. The FortiGate
unit then generates a checksum fingerprint and stores it. The FortiGate unit generates a fingerprint for all files
detected in network traffic, and it is compared to all of the fingerprints stored in its fingerprint database. If a
match is found, the configured action is taken.

The document fingerprint feature requires a FortiGate unit with internal storage.

Any type of file can be detected by DLP fingerprinting and fingerprints can be saved for each revision of your files
as they are updated.

To use fingerprinting you:

l select the documents to be fingerprinted
l add fingerprinting filters to DLP sensors
l add the sensors to firewall policies that accept the traffic to which to apply fingerprinting.

Fingerprinting

Fingerprint scanning allows you to create a library of files for the FortiGate unit to examine. It will create
checksum fingerprints so each file can be easily identified. Then, when files appear in network traffic, the
FortiGate will generate a checksum fingerprint and compare it to those in the fingerprint database. Amatch
triggers the configured action.

You must configure a document source or uploaded documents to the FortiGate unit for fingerprint scanning to
work.

Fingerprinted Documents

The FortiGate unit must have access to the documents for which it generates fingerprints.

Configuring the document source

To configure a DLP fingerprint document source in FortiOS 5.6.0, you must use CLI commands.

config dlp fp-doc-source
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edit <name_str>
set name <string>
set server-type {smb}
set server <string>
set period {none | daily | weekly | monthly}
set vdom {mgmt | current}
set scan-subdirectories {enable | disable}
set remove-deleted {enable | disable}
set keep-modified {enable | disable}
set username <string>
set password <password>
set file-path <string>
set file-pattern <string>
set sensitivity <string>
set tod-hour <integer>
set tod-min <integer>
set weekday {sunday | monday | tuesday | wednesday | thursday | friday | saturday}
set date <integer>

end

Configuring a DLP fingerprint sensor

To configure a DLP fingerprint sensor in FortiOS 5.6.0, you must use CLI commands.

config dlp sensor
edit <sensor name>

config filter
edit <id number of filter>

set proto {smtp | pop3 | imap http-get | http-post | ftp | nntp | mapi}
set filter-by fingerprint
set fp-sensitivity { critical | private | warning}
set action {allow | log-only | block | ban | quarantine-ip | quarantine-

port}
next

end
next

Once you have set the document source and configured the DLP sensor for fingerprinting, add the DLP sensor to
the applicable firewall policy. This can be done through the GUI.

File size

This filter-type checks for files exceeding a configured size. All files larger than the specified size are subject to
the configured action. The value of the field is measured in kilobytes (KB).

DLP filtering by specific file types

File filters use file filter lists to examine network traffic for files that match either file names or file types. For
example, you can create a file filter list that will find files called secret.* and also all JPEG graphic files. You can
create multiple file filter lists and use them in filters in multiple DLP sensors as required.

Specify File Types is a DLP option that allows you to block files based on their file name or their type.
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l File types are a means of filtering based on examination of the file contents, regardless of the file name. If you
block the file type Archive (zip), all zip archives are blocked even if they are renamed with a different file
extension. The FortiGate examines the file contents to determine what type of file it is and then acts accordingly.

l File Name patterns are a means of filtering based purely on the names of files. They may include wildcards (*).
For example, blocking *.scr will stop all files with an .scr file extension, which is commonly used for Windows
screen saver files. Files trying to pass themselves off asWindows screen saver files by adopting the file-naming
convention will also be stopped.
l Files can specify the full or partial file name, the full or partial file extension, or any combination. File pattern

entries are not case sensitive. For example, adding *.exe to the file pattern list also blocks any files ending
with .exe.

l Files are compared to the enabled file patterns from top to bottom, in list order.

If DLP detects a file inside an archive that should be blocked, the entire archive will be
blocked.

Watermarking

Watermarking is essentially marking files with a digital pattern to mark the file as being proprietary to a specific
company. Fortinet provides a Linux-based utility that applies a digital watermark to files. The utility adds a small
(approx. 100 byte) pattern to the file that is recognized by the DLPwatermark filter. The pattern is invisible to the
end user.

When watermarking a file it should be verified that the pattern matches up to a category found on the FortiGate
firewall. For example, if you are going to watermark a file with the sensitivity level of “Secret” you should verify
that “Secret” is a sensitivity level that has been assigned in the FortiGate unit.

Watermark Sensitivity

If you are using watermarking on your files you can use this filter to check for watermarks that correspond to
sensitivity categories that you have set up.

The Corporate Identifier is to make sure that you are only blocking watermarks that your company has place on
the files, not watermarks with the same name by other companies.

Software Versions

Before planning on using watermarking software it is always best to verify that the software will work with your
OS. Currently, the only utility available to watermark files is a Linux-based command line tool. It is available for
download from the Fortinet Customer Service & Support website, with a valid support contract and access to the
site. To access the file:

1. Sign into the Fortinet Customer Service & Support website.
2. Go to https://support.fortinet.com/Download/FirmwareImages.aspx.
3. Navigate to the image file path for /FortiGate / v5.00 / 5.0 / WATERMARK
4. Download the file fortinet-watermark-linux.out.

File types

The watermark utility does not work with every file type. The following file types are supported by the watermark
tool: .txt; .pdf; .doc; .xls; .ppt; .docx; pptx; and, .xlsx.
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Syntax of the watermark utility

The tool is executed in a Linux environment by passing in files or directories of files to insert a watermark.

USAGE:

watermark_linux_amd64 <options> -f <file name> -i <identifier> -l <sensitivity level>
watermark_linux_amd64 <options> -d <directory> -i <identifier> -l <sensitivity level>

Options:

-h print help
-I inplace watermarking (don't copy file)
-o output file (or directory in directory mode)
-e encode <to non-readable>
-i add watermark identifier
-l add watermark sensitivity level
-D delete watermark identifier
-L delete watermark sensitivity level

Regular expression

The FortiGate unit checks network traffic for the regular expression specified in a regular expression filter. The
regular expression library used by Fortinet is a variation of a library called PCRE (Perl Compatible Regular
Expressions). A number of these filters can be added to a sensor making a sort of ‘dictionary’ subset within the
sensor.

Some other, more limited DLP implementations, use a list of words in a text file to define what words are
searched for. While the format used here is slightly different than what some people are used to, the resulting
effect is similar. Each regular expression filter can be thought of as a more versatile word to be searched against.
In this dictionary (or sensor), the list of words is not limited to just predefined words. It can include expressions
that accommodate complex variations on those words and even target phrases. Another advantage of the
individual filter model of this dictionary over the list is that each word can be assigned its own action, making this
implementation much more granular.

Encrypted

This filter is a binary one. If the file going through the policy is encrypted the action is triggered.

Examining specific services

To assist in optimizing the performance of the firewall, the option exists to select which services or protocol traffic
will be checked for the targeted content. This setting gives you a tool to save the resources of the FortiGate unit
by only using processing cycles on the relevant traffic. Just check the boxes associated with the service / protocol
that you want to have checked for filter triggers.

Enable data leak prevention
DLP examines your network traffic for data patterns you specify. The FortiGate unit then performs an action
based on the which pattern is found and a configuration set for each filter trigger.

DLP is not available in flow-based inspection.
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General configuration steps

Follow the configuration procedures in the order given. Also, note that if you perform any additional actions
between procedures, your configuration may have different results.

1. Create a DLP sensor.
New DLP sensors are empty. You must create one or more filters in a sensor before it can examine network traffic.

2. Add one or more filters to the DLP sensor.
Each filter searches for a specific data pattern. When a pattern in the active DLP sensor appears in the traffic, the
FortiGate unit takes the action configured in the matching filter. Because the order of filters within a sensor cannot
be changed, you must configure DLP in sequence.

3. Add the DLP sensor to one or more firewall policies that control the traffic to be examined.

Creating/editing a DLP sensor
DLP sensors are collections of filters. You must also specify an action for the filter when you create it in a sensor.
Once a DLP sensor is configured, you add it to a security policy profile. Any traffic handled by that security policy
will be examined according to the DLP sensor configuration.

DLP is not available in flow-based inspection.

To create/edit a DLP sensor in the GUI

1. Go to Security Profiles > Data Leak Prevention.
2. Choose whether you want to edit an existing sensor or create a new one.

l The default sensor is the one displayed by default.
l To edit an existing sensor, select it by either using the drop down menu in the upper right hand corner of the

window or by selecting the List icon (the furthest right of the 3 icons in the upper right of the window,
resembling a page with some lines on it), and then selecting the profile you want to edit from the list.

l To create a new sensor, select the Create New icon (a plus sign within a circle) or the List icon and then select
the Create New link in the upper left corner of the window that appears.

3. Enter a name in the Name field for any new DLP sensors.
4. Optionally, you may also enter a comment. The comment appears in the DLP sensor list and can remind you of

the details of the sensor.
5. At this point you can add filters to the sensor (see adding filters to a DLP sensor) or select OK to save the sensor.
Without filters, the DLP sensor will do nothing.

Adding filters to a DLP sensor

Once you have created a DLP sensor, you need to add filters.

1. To add filters to a DLP sensor
2. Go to Security Profiles > Data Leak Prevention.
3. Select the sensor you wish to edit using the drop-down menu or the sensor list window.
4. Within the Edit DLP Sensor window select Create New. A New Filter window should pop up.
5. Select the type of filter. You can choose eitherMessages or Files, depending on which of these two are chosen

different options will be available.

Message filter will have these configuration options:
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l [radio button] Containing: [drop-down menu including: Credit Card # or SSN]
l [radio button] Regular Expression [input field]

Examine the following services:

Web Access

l HTTP-POST

Email

l [check box] SMTP
l [check box] POP3
l [check box] IMAP
l [check box] MAPI

Others

l [check box] NNTP

Action [from drop-down menu]

l Allow
l Log Only (default)
l Block
l Quarantine IP address

Files filter will allow you to choose one of these options:

l Containing: drop-down menu including: Credit Card # or SSN
l File Size > [ ]KB files greater than the number of KB entered
l Specify File Types

File Types: [“Click to add...”drop-down menu of File extensions]
File Name Patterns:[“Click to add...”drop-down menu]

l [radio button] Regular Expression [input field]
l [radio button] Encrypted

Examine the following Services:

Web Access

l [check box] HTTP-POST
l [check box] HTTP-GET

Email

l [check box] SMTP
l [check box] POP3
l [check box] IMAP
l [check box] MAPI

Others

l [check box] FTP
l [check box] NNTP

Action [from drop-down menu]
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l Allow
l Log Only (default)
l Block
l Quarantine IP address

6. Select OK.
7. Repeat Steps 6 and 7 for each filter.
8. Select Apply to confirm the settings of the sensor.

If you have configured DLP to block IP addresses and if the FortiGate unit receives
sessions that have passed through a NAT device, all traffic from that NAT device —
not just traffic from individual users— could be blocked. You can avoid this problem by
implementing authentication.

To view or modify the replacement message text, go to System > Replacement
Messages.

DLP archiving
DLP is typically used to prevent sensitive information from getting out of your company network, but it can also be
used to record network use. This is called DLP archiving. The DLP engine examines email, FTP, NNTP, and web
traffic. Enabling archiving for rules when you add them to sensors directs the FortiGate unit to record all
occurrences of these traffic types when they are detected by the sensor.

Since the archive setting is configured for each rule in a sensor, you can have a single sensor that archives only
the things you want.

You can archive Email, FTP, HTTP, and session control content:

l Email content includes IMAP, POP3, and SMTP sessions. Email content can also include email messages tagged
as spam by Email filtering. If your unit supports SSL content scanning and inspection, email content can also
include IMAPS, POP3S, and SMTPS sessions.

l HTTP content includes HTTP sessions. If your unit supports SSL content scanning and inspection HTTP content
can also include HTTPS sessions.

DLP archiving comes in two forms: Summary and Full.

Summary archiving records information about the supported traffic types. For example, when an email message
is detected, the sender, recipient, message subject, and total size are recorded. When a user accesses the Web,
every URL the user visits recorded. The result is a summary of all activity the sensor detected.

For more detailed records, use full archiving . When an email message is detected, the message itself, including
any attachments, is archived. When a user accesses the Web, every page the user visits is archived. Far more
detailed than a summary, full DLP archives require more storage space and processing.

Because both types of DLP archiving require additional resources, DLP archives are saved to a FortiAnalyzer unit
or the FortiGuard Analysis and Management Service (subscription required).

You can use DLP archiving to collect and view historical logs that have been archived to a FortiAnalyzer unit or the
FortiGuard Analysis and Management Service. DLP archiving is available for FortiAnalyzer when you add a
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FortiAnalyzer unit to the Fortinet configuration. The FortiGuard Analysis server becomes available when you
subscribe to the FortiGuard Analysis and Management Service.

Two sample DLP sensors are provided with DLP archiving capabilities enabled. If you select the Content_
Summary sensor in a security policy, it will save a summary DLP archive of all traffic the security policy handles.
Similarly, the Content_Archive sensor will save a full DLP archive of all traffic handled the security policy you
apply it to. These two sensors are configured to detect all traffic of the supported types and archive them. You
can see these sensors in the GUI but the configuration is only visible through the CLI; DLP archiving is set in the
CLI only.

To set the archive to Summary

config dlp sensor
edit <name of sensor>

set summary-proto smtp pop3 imap http ftp nntp msn yahoo mapi
end

To set the archive to Full

config dlp sensor
edit <name of sensor>

set full-archive-proto smtp pop3 imap http ftp nntp msn yahoo mapi
end

If you set the full-archive-proto filter to include one or more of the
protocols set by the protooption, then the archive action is disabled.

DLP examples
You can configure DLP sensors and filters when your FortiGate is operating in proxy-based inspection.

l Blocking content with credit card numbers
l Blocking emails larger than 15 MB and logging emails from 5 MB to 15 MB
l Blocking selectively based on a fingerprint

Blocking content with credit card numbers

When the objective is to block credit card numbers one of the important things to remember is that two filters will
need to be used in the sensor. One filter is to prevent sensitive files from being leaked and another is to retain any
sensitive data that is not a file (for example, messages or email content).

In the default Credit-Card sensor, you will notice a few things.

l The Action is set to Log Only
l In the Files filter not all of the services are being examined.

If you wish to block as much content as possible with credit card numbers in it instead of just logging most the
traffic that has it, the existing sensor will have to be edited.

1. Go to Security Profiles > Data Leak Prevention.
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Some configurations will have a preconfigured Credit Card sensor where you can use the drop down menu to
select Credit-Card. If your configuration doesn’t already have one create a new sensor.

2. Use the Create New icon to add a new sensor.
3. Create/edit the first filter. Set Type toMessages and select Containing Credit Card #.
4. Go to Examine the Following Services and select all services .
5. Set Action to Block.
6. Select OK orApply.
7. Create/edit the second filter. Set Type to Files and select Containing Credit Card #.
8. Go to Examine the Following Services and select all services .
9. Set Action to Block.
10. Select OK orApply.
11. Edit the appropriate policies so that under Security Profiles, DLP is turned on and the Credit-Card sensor is

selected.

Blocking emails larger than 15 MB and logging emails from 5 MB to 15 MB

Multiple filters will have to be used in this case and the order that they are used is important. Because there is no
mechanism to move the filters within the sensor the order that they are added to the sensor is important.

1. Go to Security Profiles > Data Leak Prevention.
2. Use the Create New icon to add a new sensor. Give it a descriptive Name, such as block_large_emails.

Optionally, enter a descriptive comment.
Once the sensor has been created, a new filter will need to be added.

3. Create the filter to block the emails over 15MB. In the filters table select Create New.
4. Set Type toMessages and enter 15360 in the field next to File size over. (1MB = 1024KB, 15 MB = 15 x 1024KB

= 15360KB)
5. Go to Examine the Following Services and select all Email services .
6. Set Action to Block.
7. Select OK.
8. Create the filter to log emails between 5MB and 10MB. In the filters table select Create New.
9. Set Type to Files.
10. Enter 5120 in the field next to File size over. (1MB = 1024KB, 5 MB = 5 x 1024KB = 5124KB)
11. Go to Examine the Following Services and select all the email services .
12. Set action to Log Only.
13. Select OK.

The reason that the block filter is placed first is because the filters are applied in sequence and once the traffic
triggers a filter, the action is applied and then the traffic is passed on to the next test. If the Log Only filter which
checks for anything over 1MB is triggered this would include traffic over 15MB, so a 16 MB file would only be
logged. In the described order, the 16 MB file will be blocked and the 3 MB file will be logged.

Blocking selectively based on a fingerprint

The following is a fairly complex example but shows what can be done by combining various components in the
correct configuration.
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The company has a number of copyrighted documents that it does not want “escaping” to the Internet but it does
want to be able to send those documents to the printers for turning into hardcopy.

The policies and procedures regarding this issue state that:

l Only members of the group Senior_Editors can send copyrighted material to the printers.
l Every member of the company by default is included in the group employees.
l Even permitted transmission of copyrighted material should be recorded.
l All of the printers IP addresses are in a group called approved_printers.
l There is a file share called copyrighted where any file that is copyrighted is required to have a copy stored.
l It doesn’t happen often but for legal reasons sometimes these files can be changed, but all versions of a file in this

directory need to be secured.
l All network connections to the Internet must have AntiVirus enabled using at least the default profile.
l The SSL/SSH Inspection profile used will be default.

It is assumed for the purposes of this example that:

l Any addresses or address groups have been created.
l User accounts and groups have been created.
l The account used by the FortiGate is fgtaccess.
l The copyrighted sensitivity level needs to be created.
l The copyrighted material is stored at \\192.168.27.50\books\copyrighted\

1. Add a new Sensitivity Level by running the following commands in the CLI:
config dlp fp-sensitivity

edit copyrighted
end

2. Apply files to the fingerprint database by running these commands in the CLI:
config dlp fp-doc-source

edit "copyrighted_material"
set server-type smb
set server 192.168.27.50
set username fgtaccess
set password ******
set file-path books/copyrighted/
set file-pattern *.pdf
set sensitivity copyrighted
set period daily
set tod-hour 2
set tod-min 0
set scan-subdirectories enable
set remove-deleted disable
set keep-modified enable

next
end

Two Sensors need to be created. One for blocking the transmission of copyrighted material and a second for
allowing the passing of copyrighted material under specific circumstances.

3. Create the first DLP Sensor with the following commands in CLI:
config dlp sensor

edit block_copyrighted
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config filter
edit 1

set proto smtp pop3 imap http-get http-post ftp nntp mapi
set filter-by fingerprint
set fp-sensitivity copyrighted
set action block

next
end

next

4. Create the second DLP Sensor
config dlp sensor

edit allow_copyrighted
config filter

edit 2
set proto smtp pop3 imap http-get http-post ftp nntp mapi
set filter-by fingerprint
set fp-sensitivity copyrighted
set action log-only

next
end

next

5. Create a policy to allow transmission of copyrighted material.

a. Go to Policy & Objects > IPv4 Policy.

b. Select Create New.

c. Use the following values in the policy:

Incoming Interface LAN

Source Address all

Outgoing Interface wan1

Destination Address all

Schedule always

Service all

Action ACCEPT

Enable NAT enabled -- Use Destination Interface Address

AntiVirus <ON> default

DLP <ON> Copyrighted

SSL/SSH Inspection <ON> default

Enable this policy <ON>

This policy should be placed as close to the beginning of the list of policies so the it is among the first
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tested against.

6. Create a policy to block transmission of copyrighted material.
This will in effect be the default template for all following policies in that they will have to use the DLP profile that
blocks the transmission of the copyrighted material.

a. Go to Policy & Objects > IPv4 Policy.

b. Select Create New or Edit an existing policy.

c. Use the following values in the Policy:
The fields should include what ever values you need to accomplish your requirements are but each
policy should include the DLP sensor block_copyrighted. Alternatively, if a different DLP configuration
is required it should include a filter that blocks copyrighted fingerprinted file.

If you need to create a policy that is identity based make sure that there is an Authentication rule for
the group employees that uses the DLP sensor that blocks copyrighted material.
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ICAP is the acronym for Internet Content Adaptation Protocol The purpose of the feature is to offload work that
would normally take place on the firewall to a separate server specifically set up for the specialized processing of
the incoming traffic. This takes some of the resource strain off of the FortiGate firewall leaving it to concentrate
its resources on things that only it can do.

Offloading value-added services from Web servers to ICAP servers allows those same web servers to be scaled
according to raw HTTP throughput versus having to handle these extra tasks.

ICAP servers are focused on a specific function, for example:

l Ad insertion
l Virus scanning
l Content translation
l HTTP header or URL manipulation
l Language translation
l Content filtering

The following topics are included in this section:

ICAP does not appear by default in the GUI. You must enable it in System > Feature
Visibility .

The protocol
ICAP is an Application layer protocol; its specifications are set out in RFC 3507. It is, in essence, a lightweight
protocol for executing a "remote procedure call" on HTTPmessages and is a member of the member of the
TCP/IP suite of protocols.

The default TCP that is assigned to it is 1344. Its purpose is to support HTTP content adaptation by providing
simple object-based content vectoring for HTTP services. ICAP is usually used to implement virus scanning and
content filters in transparent HTTP proxy caches. Content adaptation refers to performing the particular value
added service, or content manipulation, for an associated client request/response.

Essentially it allows an ICAP client, in this case the FortiGate firewall, to pass HTTPmessages to an ICAP server
like a remote procedure call for the purposes of some sort of transformation or other processing adaptation. Once
the ICAP server has finished processing the content, the modified content is sent back to the client.

The messages going back and forth between the client and server are typically HTTP requests or HTTP
responses. While ICAP is a request/response protocol similar in semantics and usage to HTTP/1.1 it is not HTTP
nor does it run over HTTP, as such it cannot be treated as if it were HTTP. For instance, ICAPmessages can not
be forwarded by HTTP surrogates.
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Offloading using ICAP
If you enable ICAP in a security policy, HTTP traffic intercepted by the policy is transferred to an ICAP server in
the ICAP profile added to the policy. Responses from the ICAP server are returned to the FortiGate unit which
forwards them to an HTTP client or server.

You can offload HTTP responses or HTTP requests (or both) to the same or different ICAP servers.

If the FortiGate unit supports HTTPS inspection, HTTPS traffic intercepted by a policy that includes an ICAP
profile is also offloaded to the ICAP server in the same way as HTTP traffic.

When configuring ICAP on the FortiGate unit, you must configure an ICAP profile that contains the ICAP server
information; this profile is then applied to a security policy.

Configuring ICAP
You will need to configure an ICAP server and an ICAP profile.

ICAP Servers

1. Go to Security Profiles > ICAP Servers and click on Create New.
2. Enter a Name for the server.
3. Enter the server's IP Address. Depending on whether you’ve set the IP version to 4 or 6 will determine the format

that the content of this field will be set into. In the GUI it looks like the same field with a different format but in the
CLI it is actually 2 different fields named “ip-address” and ip6-address.

4. Set the Port; 1344 is default TCP port used for the ICAP traffic. The range can be from 1 to 65535.

Maximum Connections

This value refers to the maximum number of concurrent connections that can be made to the ICAP server. The
default setting is 100. This setting can only be configured in the CLI.

The syntax is:

config icap server
edit <icap_server_name>

set max-connections <integer>
end

Profiles

1. Go to Security Profiles > ICAP and click on Create New.
2. Enter a Name for the server.
3. Enable settings as required.
a. Enable Request Processing allows the ICAP server to process request messages. If enabled this setting will

also require:
l Server - This is the name of the ICAP server. It is chosen from the drop down menu in the field. The servers are

configure in the Security Profiles > ICAP > Server section.
l Path - This is the path on the server to the processing content. For instance if the Windows share name was

“Processes” and the directory within the share was “Content-Filter” the path would be “/Processes/Content-Filter/”
l On Failure - There are 2 options: Error orBypass.
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b. Enable Response Processing allows the ICAP server to process response messages. If enabled this setting
will also require:

l Server - This is the name of the ICAP server. It is chosen from the drop down menu in the field. The servers are
configure in the Security Profiles > ICAP > Server section.

l Path - This is the path on the server to the processing compent. For instance if the Windows share name was
“Processes” and the directory within the share was “Content-Filter” the path would be “/Processes/Content-Filter/”

l On Failure - There are 2 options. You can choose by the use of radio buttons either Error orBypass.
c. Enable Streaming Media Bypass allows streamingmedia to ignore offloading to the ICAP server.
4. Select Apply.

Example ICAP sequence
This example is for an ICAP server performing web URL filtering on HTTP requests

1. A user opens a web browser and sends an HTTP request to connect to a web server.
2. The FortiGate unit intercepts the HTTP request and forwards it to an ICAP server.
3. The ICAP server receives the request and determines if the request is for URL that should be blocked or allowed.

l If the URL should be blocked the ICAP server sends a response to the FortiGate unit. The FortiGate unit
returns this response to the user’s web browser. This response could be a message informing the user that their
request was blocked.

l If the URL should be allowed the ICAP server sends a request to the FortiGate unit. The FortiGate unit
forwards the request to the web server that the user originally attempted to connect to.

l When configuring ICAP on the FortiGate unit, you must configure an ICAP profile that contains the ICAP server
information; this profile is then applied to a security policy.

Example ICAP scenario
Information relavent to the following example:

l The ICAP server is designed to do proprietary content filtering specific to the organization so it will have to receive
the messages and sent back appropriate responses.

l The content filter is a required security precaution so it if the message cannot be processed it is not allowed
through.

l Resources on both the FortiGate and the ICAP server are considerable so the maximum connections setting will set
at a double the default value to analyze the impact on performance.

l The ICAP server’s IP address is 172.16.100. 55.
l The path to the processing component is “/proprietary_code/content-filter/”.
l Streaming media is not something that the filter considers, but is allowed through the policy so processing it would

be a waste of resources.
l The ICAP profile is to be added to an existing firewall policy.
l It is assumed that the display of the policies has already been configured to show the column “ID”.

1. Enter the following to configure the ICAP server:

Go to Security Profiles > ICAP Servers.
Use the following values:
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Name content-filtration-server4

IP Type IPv4

IP Address 172.16.100.55

Port 1344

Use the CLI to set the max-connections value.

config icap server
edit content-filtration-server4

set max-connections 200
end

2. Enter the following to configure the ICAP profile to then apply to a security policy:

Use the following values:

Name Prop-Content-Filtration

Enable Request Processing enable

Server content-filtration-server4

Path /proprietary_code/content-filter/

On Failure Error

Enable Response
Processing

enable

Server content-filtration-server4

Path /proprietary_code/content-filter/

On Failure Error

Enable Streaming Media
Bypass

enable

3. Apply the ICAP profile to policy:
The purposes of this particular ICAP profile is to filter the content of the traffic coming through the firewall via
policy ID#17.

a. Go to Policy & Objects > IPv4 Policy.

b. Open the existing policy ID# 17 for editing.

c. Go to the section Security Profiles.

d. Select the button next to ICAP so that it indicates that it’s status isON.

e. Select the field with the profile name and use the drop down menu to select Prop-Content-Filtration.

f. Select OK.
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This section describes the FortiClient Profiles endpoint protection features and configuration.

FortiClient Profiles are used primarily to make sure connected devices are compliant with Endpoint Control and to
protect against vulnerabilities. Both Endpoint Vulnerability Scan on Client and System compliance are
enabled by default, while other settings are disabled by default. This allows FortiClient to work as part of a
Security Fabric.

You must first enable this feature. Go to System > Feature Visibility and enable Endpoint Control. This
will reveal the Security Profiles > FortiClient Profiles menu item.

The following topics are included in this section:

Endpoint protection overview
Endpoint Protection enforces the use of up-to-date FortiClient Endpoint Security software on endpoints
(workstation computers and mobile devices). It pushes a FortiClient profile to the FortiClient application,
specifying security settings, including:

l Real-time antivirus protection - on or off
l FortiClient web category filtering based on web filters defined in a FortiGate Web Filter profile
l FortiClient Application Control (application firewall) using application sensors defined in the FortiGate Application

Control profile

The FortiClient profile can also:

l Create VPN configurations
l Install CA certificates
l Upload logs to FortiAnalyzer or FortiManager
l Enable use of FortiManager for client software/signature update
l Enable a dashboard banner
l Enable client-based logging while on-net
l Output a mobile configuration profile (.mobileconfig file for iOS)

User experience

When using a web browser, the user of a non-compliant endpoint receives a replacement message HTML page
from the FortiGate unit. The message explains that the user needs to install FortiClient Endpoint Security and
provides a link to do so. The user cannot continue until the FortiClient software is installed.

For information about modifying the replacement message, see Modifying the endpoint protection replacement
messages on page 2923.

2916 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



FortiClient Profiles

Default FortiClient non-compliance message for Windows

After installing FortiClient Endpoint Security, you will receive an invitation to register with the FortiGate unit. If
you accept the invitation, the FortiClient profile is sent to the device's FortiClient application. Now the device is
compliant and can connect to the network. FortiClient Endpoint Security registered with a FortiGate unit does not
need to be separately licensed with FortiGuard.

The FortiGate unit can also register endpoints connecting over the Internet through a VPN. See Configuring
endpoint registration over a VPN on page 2921.

Licensing and FortiGate endpoint registration limits

To view the number of endpoints that are registered and the total that can be registered, go to Dashboard.
Under Licenses, find FortiClient. You will see text like "4 /10". This means that there are four registered
endpoints and a total of ten are allowed.

When the registration limit is reached, the next FortiClient-compatible device will not be able to register with the
FortiGate unit. A message appears in the FortiClient application. The FortiClient profile is not sent to client and
the client cannot connect through the FortiGate unit.

For all FortiGate models, the maximum number of registered endpoints is ten. For all models except 20C, you
can purchase an endpoint license to increase this capacity:
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To add an endpoint license - GUI

1. Go to Dashboard.
2. In the Licenseswidget, click on FortiClient, select Enter License.
3. Enter the license key in the window that sllides in from the right, and select OK.

Maximum registered endpoints with endpoint license

FortiClient endpoint licenses for FortiOS 5.6.0 can be purchased in multiples of 100. There is a maximum client
limit based on the FortiGate's model. FortiCare enforces the maximum limits when the customer is applying the
license to a model.

If you are using the ten free licenses for FortiClient, support is provided on the Fortinet Forum
(forum.fortinet.com). Phone support is only available for paid licenses.

Model(s) Maximum client limit

VM00 200

FGT/FWF 30 to 90 series 200

FGT 100 to 400 series 600

FGT 500 to 900 series, VM01, VM02 2,000

FGT 1000 to 2900 series 20,000

FGT 3000 to 3600 series, VM04 50,000

FGT 3700D and above, VM08 and above 100,000

Older FortiClient SKUs will still be valid and can be applied to FortiOS 5.4 and 5.6.

Configuring endpoint protection
Endpoint Protection requires that all hosts connecting to an interface have the FortiClient Endpoint Security
application installed. Make sure that all endpoints behind the interface are able to install this application.
Currently, FortiClient Endpoint Security is available for Microsoft Windows (2000 and later), Apple (Mac OS X and
later), and Android devices only.

By default, the FortiGuard service provides the FortiClient installer. If you prefer to host it on your own server, see
Changing the FortiClient installer download location, below.

To set up Endpoint Protection, complete the following:

l Create a FortiClient Profile or use the default profile. See Creating a FortiClient profile on page 2919. Enable the
application sensor and web category filtering profiles that you want to use.

l Configure the FortiGate unit to support endpoint registration using FortiTelemetry (underNetwork > Interfaces,
allow FortiTelemetry admission control).

l Optionally, enforce FortiClient registration. See Enforcing FortiClient registration on page 2920.
l Optionally, configure application sensors and web filter profiles as needed to monitor or block applications.
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l Optionally, modify the Endpoint NAC Download Portal replacement messages (one per platform). See
Modifying the endpoint protection replacement messages on page 2923.

Creating a FortiClient profile

FortiClient profiles allow you to perform vulnerability scans on endpoints and make sure endpoints are running
compliant versions of FortiClient. Also, security posture features cause FortiClient to apply realtime protection,
AntiVirus, web filtering, and application control on endpoints.

It is possible for more than one profile to be assigned to a device type. As with security policies, clients are
matched to FortiClient profiles in the order that the profiles appear in the list.

Features involving general settings have been removed from the FortiClient profile GUI in 5.4.1. Features
emphasizing compliance of the endpoint devices have been added. These enhancements facilitate integration
with the Security Fabric.

To create a FortiClient profile - GUI - FortiOS 5.6.0

1. If you plan to use the Application Firewall feature in the FortiClient profile, go to Security Profiles >
Application Control to create the Application Sensors that you will need.

2. If you plan to use the Web Category Filtering, go to Security Profiles > Web Filter to create the Web Filter
Profile that you will need.

3. Go to Security Profiles > FortiClient Profiles. If there is only the default FortiClient profile, it will be displayed
and ready to edit. At the top right of the page you can select or create other profiles.

4. Select Create New or edit an existing profile.
5. In Assign Profile To, select the device groups, user groups, and users to which this FortiClient profile applies.

This is not available for the default profile.
6. Set the Endpoint Vulnerability Scan on Client quarantine level. Similar to FortiOS 5.4, you can set the

FortiClient Profile to run the FortiClient vulnerability scanner on endpoints and you can set the vulnerability
quarantine level to quarantine endpoints that don't comply.The FortiGate will quarantine a host when a
vulnerability with the level of severity selected, or higher, is detected. Options are: Critical, High, Medium, Low,
and Information.

7. System ComplianceFortiOS 5.6 system compliance settings are similar to those in 5.4 with the addition of a
non-compliance action. System compliance checking is performed by FortiClient but the non-compliance action is
applied by the FortiGate:

l select theMinimum FortiClient version, if necessary. The lowest supported version is 5.4.1.
l identify which logs, if any, you will upload to FortiAnalyzer
l set the Non-compliance action: Block orWarning.

8. Under Security Posture Check, enable the required options for your network:
l Realtime Protection
l Third party AntiVirus on Windows is required for Windows endpoints
l identify which logs, if any, you will upload to FortiAnalyzer
l select whether to enable anWeb Filter security profile, and / or anApplication Control sensor.
l set the Non-compliance action: Block orWarning.

9. Select OK orApply.

To create a FortiClient profile - CLI:

This example creates a profile for Windows and Mac computers.
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config endpoint-control profile
edit ep-profile1

set device-groups mac windows-pc
config forticlient-winmac-settings

set forticlient-av enable
set forticlient-wf enable
set forticlient-wf-profile default

end
end

Enforcing FortiClient registration

When you enable FortiTelemetry (formerly known as FortiHeartbeat) on an interface, the option to enforce
FortiClient registration becomes available. Devices connecting to that interface are forced to register to the
FortiGate and install FortiClient before gaining access to network services.

The following example includes editing the default FortiClient Profile to enforce real time antivirus protection and
malicious website blocking.

To enforce FortiClient registration on the internal interface - GUI:

1. On the FortiGate, go to System > Feature Visibility and enable Endpoint Control.
2. Go to Network > Interfaces and edit the internal interface.
3. UnderAdministrative Access, enable FortiClient Telemetry.
4. UnderAdmission Control, enable Enforce FortiClient Compliance Check.

Once this is enabled, you have the option to Exempt Sources and/or Exempt Destinations/Services. If you
were to exempt a source device, that device would not require FortiClient registration to access network services
or the Internet.

5. Go to Security Profiles > FortiClient Profiles.
6. Under the Security Posture Check , enable Realtime Protection, Up-to-date signatures.

Changing the FortiClient installer download location

By default, FortiClient installers are downloaded from the FortiGuard network. You can also host these installers
on a server for your users to download. In that case, you must configure FortiOS with this custom download
location. For example, to set the download location to a customer web server with address custom.example.com,
enter the following command:

config endpoint-control settings
set download-location custom
set download-custom-link "http://custom.example.com"

end

Storing FortiClient configuration files

Advanced FortiClient configuration files of up to 32k may be stored:

1. Enable the advanced FortiClient configuration option in the endpoint profile:

config endpoint-control profile
edit "default"

set forticlient-config-deployment enable
set fct-advanced-cfg enable
set fct-advanced-cfg-buffer "hello"
set forticlient-license-timeout 1
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set netscan-discover-hosts enable
next

end

2. Export the configuration from FortiClient (xml format).
3. Copy the contents of the configuration file and paste in the advanced FortiClient configuration box.

If the configure file is greater than 32k, you need to use the following CLI:

config endpoint-control profile
edit <profile>

config forticlient-winmac-settings
config extra-buffer-entries

edit <entry_id>
set buffer xxxxxx

next
end

end
next

end

Blocking access to unsupported FortiClient endpoints

You can use the following command to deny registration of unsupported FortiClient endpoints. An unsupported
FortiClient endpoint means the endpoint is running FortiClient but for some reason not all of the criteria are
available to identify the endpoint, or the endpoint may be running an unsupported version of FortiClient.
Information required that is not available could include the endpoint's IP address or MAC address is not visible.

config endpoint-control setting
set forticlient-dereg-unsupported-client enable

end

Configuring the FortiClient offline grace period

Administrators can configure an offline grace period for registered and offline FortiClients so that PROBE can be
processed and, as a result, endpoint compliance is not triggered.

l The grace period is allowed for a client that is compliant, registered, and offline.
l The grace period has a used status which determines if the client is before, during, or after grace period.
l Online and compliant clients will reset the grace status to unused.

Syntax

config endpoint-control settings
set forticlient-offline-grace {enable | disable}
set forticlient-offline-grace-interval <seconds> <-- The default is 120

end

Configuring endpoint registration over a VPN
FortiGate units can register FortiClient-equipped endpoints over either an interface-based IPsec VPN or a tunnel-
mode SSL VPN. After the user authenticates, the FortiGate unit sends the FortiClient application the IP address
and port to be used for registration. If the user accepts the FortiGate invitation to register, registration proceeds
and the FortiClient profile is downloaded to the client.
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Users without FortiClient Endpoint Security connecting to the SSL VPN through a browser are redirected to a
captive portal to download and install the FortiClient software.

Endpoint registration on an IPsec VPN

You can enable endpoint registration when you configure the FortiClient VPN or you can enable it on an existing
FortiClient VPN.

To enable endpoint registration while configuring the VPN

l Enable Allow Endpoint Registration on the Policy & Routing page of the VPNWizard when creating the
FortiClient VPN.

This is only available when Template Type is set to Remote Accesswith a
FortiClient Remote Device Type.

To enable endpoint registration on an existing VPN

1. Go to Network > Interfaces and edit the VPN's tunnel interface.
The tunnel is a virtual interface under the physical network interface.

2. In Admission Control, enable FortiClient Telemetry.
Optionally, you can also enable Enforce FortiClient Telemetry for all FortiClients. This forces endpoints to
register with FortiClient before they have network access.

3. Select OK.

Endpoint registration on an SSL-VPN

To enable endpoint registration on the SSL-VPN

1. Go to VPN > SSL-VPN Settings.
2. In Tunnel Mode Client Settings, make sure Allow Endpoint Registration is enabled.
3. Select Apply.
4. Go to Network > Interfaces and edit the ssl.root interface.
5. In Admission Control, enable FortiTelemetry.

Optionally, you can also enable Enforce FortiClient Telemetry for all FortiClients. This forces endpoints to
register with FortiClient before they have network access.

6. Select OK.
This procedure does not include all settings needed to configure a working SSL-VPN.

Synchronizing endpoint registrations

To support roaming users in a network with multiple FortiGate units, you need to configure synchronization of the
endpoint registration databases between the units. The registered endpoints are then recognized on all of the
FortiGate units. This is configured in the CLI. For example, to synchronize this FortiGate unit’s registered
endpoint database with another unit named other1 at IP address 172.20.120.4, enter:

config endpoint-control forticlient-registration-sync
edit other1

set peer-ip 172.20.120.4
end
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Modifying the endpoint protection replacement messages
If the security policy hasRedirect all non-compliant/unregistered FortiClient compatible devices to a
captive portal enabled, users of non-compliant devices are redirected to a captive portal that is defined by the
Endpoint NAC Download Portal replacement message. There are different portals for Android, iOS, Mac,
Windows, Quarantine, and “other” devices.

To modify the the endpoint protection replacement messages

1. Go to System > Replacement Messages and select Extended View.
2. In the Endpoint Control section select the message that you want to edit.

The replacement message and its HTML code appear in a split screen in the lower half of the page.
3. Modify the text as needed and select Save.

Monitoring endpoints
Go toMonitor > FortiClient Monitor to monitor endpoints.

TheMonitor page allows the user to view FortiClient endpoint devices grouped by interface and then sub-
grouped by compliance status. Compliance status can be compliant, non-compliant, exempt, or quarantined.

Status Enforcement Enabled Enforcement Disabled

Compliant List only active FortiClient endpoints. No devices listed.

Not-compliant List devices not-compliant with
FortiClient profile, so long as they are not
exempt.

No devices listed.

Exempt* List FortiClient endpoints exempt from
FortiClient compliance.

List of all user devices except those
quarantined by the administrator.

Quarantined List devices quarantined by the
administrator.

List devices quarantined by the
administrator.

* Includes device exempt reasons as any combination of device, device category/group, and source address.

You can see the reasons for non-compliance by right-clicking on an endpoint in the list.

Proxy Options

Certain inspections defined in security profiles require that the traffic be held in proxy while the inspection is
carried out. When a security profile requiring the use of a proxy is enabled in a policy, the Proxy Options field is
displayed. The Proxy Options define the parameters of how the traffic will be processed and to what level the
traffic will be processed. There can be multiple security profiles of a single type. There can also be a number of
unique Proxy Option profiles. As the requirements for a policy differ from one policy to the next, a different Proxy
Option profile for each individual policy can be configured or one profile can be repeatedly applied.

The Proxy Options refer to the handling of the following protocols:
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l HTTP
l SMTP
l POP3
l IMAP
l FTP
l NNTP
l MAPI
l DNS

The configuration for each of these protocols is handled separately.

The use of different proxy profiles and profile options
Just like other components of the FortiGate, different Proxy Option profiles can be configured to allow for
granular control of the FortiGate. In the case of the Proxy Option profiles the thing that you will want to focus on is
the matching up of the correct profile to a firewall policy that is using the appropriate protocols. If you are creating
a Proxy Option profile that is designed for policies that control SMTP traffic into your network you only want to
configure the settings that apply to SMTP. You do not need or want to configure the HTTP components.

Proxy Options profile components
Highlighted below are certain features available in the Proxy Options security profile.

Log Oversized Files

This setting enables logging of the occurrence of oversized files being processed. It does not change how they
are processed. It only enables the FortiGate unit to log that they were either blocked or allowed through. A
common practice is to allow larger files through without antivirus processing. This allows you to get an idea of
how often this happens and decide on whether or not to alter the settings relating to the treatment of oversized
files.

The setting of the threshold for oversized files and emails is found on the Security Profiles > Proxy Options page
underCommon Options.

RPC over HTTP

FortiGate units with firmware version 5.4 and higher support RPC over HTTP. This protocol is used by the
Microsoft Exchange Server to perform virus scanning of Microsoft Exchange Server email that uses RPC over
HTTP. To enable this feature, go to Security Profiles > Proxy Options and enable RPC over HTTP.

Protocol Port Mapping

To optimize the resources of the unit, the mapping and inspection of protocols can be enabled or disabled.

Each of the protocols listed in the GUI has a commonly used default TCP port, however, the port used by the
protocols can be individually modified. It can also be set to inspect any port with flowing traffic for that particular
protocol. The headers of the packets indicate which protocol generated the packet.
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Comfort Clients

When proxy-based antivirus scanning is enabled, the FortiGate unit buffers files as they are downloaded. Once
the entire file is captured, the FortiGate unit begins scanning the file. During the buffering and scanning
procedure, the user must wait. After the scan is completed, if no infection is found, the file is sent to the next step
in the process flow. If the file is a large one this part of the process can take some time. In some cases enough
time that some users may get impatient and cancel the download.

The Comfort Clients feature mitigates this potential issue by feeding a trickle of data while waiting for the scan
to complete. The user then knows that processing is taking place and that there hasn’t been a failure in the
transmission. The slow transfer rate continues until the antivirus scan is complete. Once the file has been
successfully scanned and found to be clean of any viruses, the transfer will proceed at full speed.

If there is evidence of an infection, the FortiGate unit caches the URL and drops the connection. The client does
not receive any notification of what happened because the download to the client had already started. Instead,
the download stops and the user is left with a partially downloaded file. If the user tries to download the same file
again within a short period of time, the cached URL is matched and the download is blocked. A notification that
the download has been blocked is displayed. The number of URLs in the cache is limited by the size of the cache.

Client comforting is available for HTTP and FTP traffic. If your FortiGate unit supports SSL content scanning and
inspection, you can also configure client comforting for HTTPS and FTPS traffic.

Buffering the entire file allows the FortiGate unit to eliminate the danger of missing an
infection due to fragmentation because the file is reassembled before examination.
Client comforting can send unscanned and therefore potentially infected content to
the client. You should only enable client comforting if you are prepared to accept this
risk. Keeping the client comforting interval high and the amount low will reduce the
amount of potentially infected data that is downloaded.

Block Oversized File/Email

This feature is related to antivirus scanning. The FortiGate unit has a finite amount of resources that can be used
to buffer and scan a file. If a large file such as an ISO image or video file was to be downloaded this could
overwhelm or exceed the memory of the FortiGate, especially if there were other large files being downloaded at
the same time. For this reason, the treatment of large files needs to be addressed.

A threshold is assigned to identify an oversize file or email. This can be set at any size from 1 MB to 10 MB. Any
file or email over this threshold will not be processed by policies applying the Antivirus security profile.

It should be noted that in terms of probability that malware is more likely to be found in
smaller files than in larger files. A number of administrators take this into account
when they lower the default threshold so as to lessen the impact on memory if they
see the FortiGate unit going into conserve mode on a regular basis.

Chunked Bypass

The HTTP section allows the enabling of Chunked Bypass. This refers to the mechanism in version 1.1 of
HTTP that allows a web server to start sending chunks of dynamically generated output in response to a request
before actually knowing the actual size of the content. Where dynamically generated content is concerned,
enabling this feature means that there is a faster initial response to HTTP requests. From a security stand point,
enabling this feature means that the content will not be held in the proxy as an entire file before proceeding.
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Allow Fragmented Messages

The specifications of RFC 2046 allow for the breaking up of emails and sending the fragments in parallel to be
rebuilt and read at the other end by the mail server. It was originally designed to increase the performance over
slower connections where larger email messages were involved. It will depend on your mail configuration if this is
even possible for your network but outside of Microsoft Outlook and Outlook Express, not many email clients are
set up to break up messages like this. The drawback of this feature is that if malware is broken up between
multiple fragments of the message the risk is run that it will not be detected by some antivirus configurations
because the code may not all be present at the same time to identify.

Append Email Signature

The Append Email Signature feature ensures that all of the emails going out of a particular network has the
appropriate signature or corporate message, for example. These appended emails do not replace existing
signatures.

Examples could include things like:

l Without prior approval the email should not be forwarded.
l Please be environmentally friendly and don’t print out emails
l For questions regarding the purchasing of our products please call...

It can be anything that the organization would like as long as it is in text format. The use of this feature usually
works best in an environment where there is some standardization of what goes into the personal signatures of
the senders so that there is no duplication or contradiction of information in the signatures.

SSL/SSH Inspection

Individual deep inspection security profiles can be created depending on the requirements of the policy.
Depending on the inspection profile selected, you can:

l Configure which Certificate Authority (CA) certificate will be used to decrypt the Secure Sockets Layer (SSL)
encrypted traffic.

l Configure whether a specific SSL protocol will be inspected, blocked or bypassed.
l Configure which ports will be associated with which SSL protocols for the purpose of inspection.
l Configure which websites or website categories will be exempt from SSL inspection
l Identify how to treat invalid, unsupported or untrusted SSL certificates.
l Determine which inspection method will be applied to Secure Shell (SSH) / SSL traffic.

SSL inspection
Secure Sockets Layer (SSL) content scanning and inspection allows you to apply antivirus scanning, web filtering,
FortiGuard Web Filtering, and email filtering to encrypted traffic. To perform SSL content scanning and
inspection, the FortiGate unit does the following:

l intercepts and decrypts HTTPS, IMAPS, POP3S, SMTPS, and FTPS sessions between clients and servers
(FortiGate SSL acceleration speeds up decryption)
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l applies content inspection to decrypted content, including:
l HTTPS, IMAPS, POP3S, and SMTPS Antivirus, DLP, and DLP archiving
l HTTPSweb filtering and FortiGuard web filtering
l IMAPS, POP3S, and SMTPS email filtering

l encrypts the sessions and forwards them to their destinations.

FortiGate SSL content scanning and inspection packet flow

SSL inspection and privacy

Normally, SSL decrypted content is temporarily stored in system memory for content scanning. If Malware is
found the infected content is deleted and a message is sent to the destination instead. If no Malware is found the
content is re-encrypted and forwarded to its destination. Administrators are not able to access or view the
decrypted content.

There are two exceptions that you should be aware of if you have privacy concerns:

l If Sandbox inspection is enabled, either with an on-premises FortiSandbox device or FortiCloud Sandbox,
decrypted files can be sent to FortiSandbox or FortiSandbox cloud where they can be viewed by system
administrators.

l For flow-based SSL inspection, if SSL mirroring is enabled it is possible to "mirror" or send a copy of the decrypted
content to one or more FortiGate interfaces so that the content can be collected by a raw packet capture tool for
archiving or analysis. This feature is only available if the inspection mode is set to flow-based.

Decryption, storage, inspection, and use decrypted content is subject to local privacy
rules. Use of these features could enable malicious users with administrative access to
your FortiGate to harvest sensitive information submitted using an encrypted channel.

For increased privacy of sensitive information, you can use the SSL inspection exemptions feature, described
below, to exempt sensitive communication from decryption.

SSL inspection exemptions

When you are using a browser to visit SSL encrypted sites and are using a certificate that does not match the
certificate of the site, you are presented with a warning message and the option of continuing with the untrusted
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certificate, or terminating the session. However, there are a number of applications that use SSL encrypted
traffic. Some applications will not allow SSL traffic that isn't signed with a trusted certificate. These applications
do not necessarily give the option to manually indicate that we trust the certificate or the site. If the option is
available, the customer may choose to import needed SSL certificates into Local Certificates and configure a
policy for communication for that application.

To assist in preventing loss of access to these sites while still enabling the SSL inspection of the rest of the
internet traffic, a method of exempting either web categories or specific sites has been developed. To exempt a
large group of sites, the SSL/SSH Inspection profile can be configured to exempt FortiGuard Categories. There
are three preselected categories due to the high likelihood of issues with associated applications with the type of
websites included in these categories.

l Finance and Banking
l Heath and Wellness
l Personal Privacy

Other more specific websites can be added to the exemption list by going to Security Profiles >
SSL Inspection, selecting the appropriate profile, and adding addresses under Exempt from SSL Inspection.

When you create a custom web category and tell the inspection profile to exempt that
category, you may find some URLs in that category are still inspected. As a best
practice, use the Static URL Filter "Exempt" option instead.

Your FortiGate unit has two pre-configured SSL/SSH Inspection profiles that cannot be edited: certificate-
inspection and deep-inspection. You must clone and edit the pre-configured profiles or create a new profile to
exempt any additional sites or FortiGuard categories.

Allow Invalid SSL Certificates

It might seem like a straightforward decision that the allowing of invalid SSL certificates must be bad and,
therefore, should not be allowed. However, there can be some reasons that applying this feature should be
considered.

At a purely technical level, a properly formed certificate will encrypt the data so that it can only be read by the
intended parties and not be read by anyone sniffing traffic on the network. For this reason, people will often use
self-signed certificates. These self-signed certificates are free and will encrypt the data just as securely as a
purchased certificate. The self-signed certificates, however, are not likely to recognized by the CA certificate store
so will be considered by any checks against that store as invalid.

On the other hand, one of the services the vendors provide is verification of identity of those that purchase their
certificates. This means that if you see a valid certificate from a site that identified itself as being from “valid-
company.com” that you can be reasonably sure that the site does belong to that company and not a false site
masquerading as being part of that company.

You can allow invalid SSL certificates by going to Security Profiles > SSL Inspection, selecting the
appropriate profile, and enabling Allow Invalid SSL Certificates.

During the SSL handshake, a number of checks are made to verify the validity of the certificate.

One source of the checks, is against a CA certificate store inside FortiOS. This is the same CA bundle used by the
browser Mozilla Firefox.

Updates to the store are:

2928 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



SSL/SSH Inspection

l With each new version of FortiOS
l Via internal FGD
l Possible with some builds via FTP

Details of the CA certificate store can be found at: https://curl.haxx.se/docs/caextract.html

The following checks are made for validity:

Validity
Check Description

Signature One of the things being checked against the CA bundle is the certificate signature. These
signatures are generated via directly signing by the CA's private key.

Expiration
date

All certificates have an expiry date. The date, based on the devices clock/calendar is
compared to the expiry date of the certificate.

Revoked list Periodically, certificates are revoked. If a certificate has been revoked it is put on a list.
Whenever a certificate is being verified, it is checked against this list.

Self signed
certificate

In the case of self-signed certificates, the IPS engine and proxy have different handling.
IPS engine will keep and use the certificate self-signed certificate, but the public key will be
replaced so that SSL inspection can take place. The proxy engine will re-sign the certificate
with the untrusted CA certificate. The mechanics are similar but the net effect for the user
is similar. The user will get warnings from browsers. The users can choose to remember the
self-signed certificate in some browsers, but cannot do the same thing with the certificate
re-signed with the untrusted CA.

Intermediate
CA with a
weak hash
algorithm,
such as
MD5, SHA1

Some browsers like Chrome or Firefox will give a warning because of a weak signature
algorithm (visit https://sha1-intermediate.badssl.com to test).

In the IPS Engine, in order to convey the weak intermediate CA back to client, the signature
hash algorithm is downgraded in the re-signed server certificate to the weakest algorithm
used in the original certificate chain.

In the Proxy Engine - In the case of a weak signature algorithm, the Proxy engine will treat
the connection as untrusted, and re-sign the server certificate with the untrusted CA. The
final user experience is different. Instead of a warning like "NET::ERR_CERT_WEAK_
SIGNATURE_ALGORITHM” that you would get in Chrome, you will get a warning that the
certificate couldn’t be verified (because of the signing CA is not trusted or imported into the
user’s web browser).

Flow-based behaviour

In flow-based mode, a certificate will be considered as invalid if it has expired.

In addition, a certificate will be considered as untrusted if one or more of the following conditions are met:

l If the chain is broken or incomplete.
l If it is part of the CRL.
l If the CA certificate was not imported to the FortiGate, or it is not in the FortiGate CA certificate store.
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Why use SSL inspection
Most of us are familiar with Hypertext Transfer Protocol Secure (HTTPS) and how it protects a variety of activities
on the Internet by applying Secure Sockets Layer (SSL) encryption to the web traffic. However, there are risks
associated with its use, since encrypted traffic can be used to get around your network's normal defenses. 

For example, you might download a file containing a virus during an e-commerce session.  Or you could receive a
phishing email containing a seemingly harmless downloader file that, when launched, creates an encrypted
session to a command and control (C&C) server and downloads malware onto your computer. Because the
sessions in these attacks are encrypted, they might get past your network's security measures.

To protect your network from these threats, SSL inspection is the key your FortiGate uses to unlock encrypted
sessions, see into encrypted packets, find threats, and block them. SSL inspection not only protects you from
attacks that use HTTPS, but also from other commonly used SSL-encrypted protocols, such as SMTPS, POP3S,
IMAPS, and FTPS.

Full SSL inspection

To make sure that all SSL encrypted content is inspected, you must use full SSL inspection (also known as deep
inspection). When full SSL inspection is used, the FortiGate impersonates the recipient of the originating SSL
session, then decrypts and inspects the content. The FortiGate then re-encrypts the content, creates a new SSL
session between the FortiGate and the recipient by impersonating the sender, and sends the content to the
sender.

When the FortiGate re-encrypts the content it uses a certificate stored on the FortiGate. The client must trust this
certificate to avoid certificate errors. Whether or not this trust exists depends on the client, which can be the
computer’s OS, a browser, or some other application, which will likely maintain it’s own certificate repository. For
more information about this, see the recipe Preventing certificate warnings on the Fortinet Cookbook site.

There are two deployment methods for full SSL inspection:

1. Multiple Clients Connecting to Multiple Servers:

l Uses a CA certificate (which can be uploaded using the Certificatesmenu).
l Typically applied to outbound policies where destinations are unknown (i.e. normal web traffic).
l Address and web category whitelists can be configured to bypass SSL inspection.

2. Protecting SSL Server

l Uses a server certificate (which can be uploaded using the Certificatesmenu) to protect a single server.
l Typically used on inbound policies to protect servers available externally through Virtual IPs
l Since this is typically deployed “outside-in” (clients on the Internet accessing server(s) on the internal side of the

FortiGate), server certificates using the public FQDN of the server are often purchased from a commercial
Certificate Authority and uploaded to the FortiGate. This avoids client applications generating SSL certificate errors
due to certificate mismatch.

More detail is available in the Fortinet Knowledge Base. Check these technical notes:

l How to Enable SSL inspection from the CLI and Apply it to a Policy
l How to block web-based chat on Gmail webmail using App Sensor + SSL inspection
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SSL certificate inspection
FortiGates also supports a second type of SSL inspection, called SSL certificate inspection. When certificate
inspection is used, the FortiGate only inspects the header information of the packets.

Certificate inspection is used to verify the identity of web servers and can be used to make sure that HTTPS
protocol isn't used as a workaround to access sites you have blocked using web filtering.

The only security feature that can be applied using SSL certificate inspection mode is web filtering. However,
since only the packet is inspected, this method does not introduce certificate errors and can be a useful
alternative to full SSL inspection when web filtering is used.

Troubleshooting

The most common problem with SSL inspection is users receiving SSL errors when the CA certificate is not
trusted. This is because by default the FortiGate uses a certificate that is not trusted by the client. There are two
ways to fix this:

1. All users must import the FortiGate’s default certificate into their client applications as a trusted certificate.
2. Configure the FortiGate to use a certificate that is already trusted by your clients. For example, a certification

signed by a CA that your clients already trust.
The first method can be more labor intensive because you have to distribute a certification to all clients. This can
also be an ongoing problem as new clients are added to your network. The second method is usually less work
but may require paying for a CA. Both of these methods are covered in the recipe Preventing Certificate
Warnings.

If you choose to install the certificate on client applications, this can be done with greater ease in a Microsoft
Active Directory domain environment by using Group Policy Objects to install the certificate on domain members.
Check that the Group Policy has propagated to all computers by opening Internet Explorer on a workstation PC,
opening Tools > Internet Options > Content > Certificates >Trusted Root Certification Authorities, and
ensuring that the FortiGate's certificate is present.

For corporate-owned mobile devices, MDM solutions like AirWatch, MobileIron, or Fiberlink, use Simple
Certificate Enrollment Protocol (SCEP) to ease certificate enrollment.

Best practices

Because all traffic needs to be decrypted, inspected, and re-encrypted, using SSL inspection can reduce overall
performance of your FortiGate. To make sure you aren't using too many resources for SSL inspection, do the
following:

l Know your traffic – Know how much traffic is expected and what percent of the traffic is encrypted. You can also
limit the number of policies that allow encrypted traffic.

l Be selective – Use white lists or trim your policy to apply SSL inspection only where it is needed.
l Use hardware acceleration - FortiGate models with either the CP6 or CPU processor have an SSL/TLS protocol

processor for SSL content scanning and SSL acceleration. For more information about this, see the Hardware
Acceleration handbook.

l Test real-world SSL inspection performance yourself - Use the flexibility of FortiGate’s security policy to
gradually deploy SSL inspection, rather than enabling it all at once.
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Creating or editing an SSL/SSH Inspection profile
1. Go to Security Profiles > SSL/SSH Inspection. This will open to one of the existing profiles. Your FortiGate

unit has two pre-configured SSL/SSH Inspection profiles that cannot be edited: certificate-inspection and deep-
inspection. You must clone and edit the pre-configured profiles or create a new profile to exempt any additional
sites or FortiGuard categories. The links for the actions are located in the upper right hand corner of the window.

l To view a list of the existing profiles select the List icon (a page) at the far right.
l To clone an existing profile, select the Clone icon (one page behind another), second from the right
l To create a new profile, select the Create New icon ("+ "symbol), third from the right.
l To view or edit an existing profile, choose it from the dropdown menu field.

2. Name Field:
Give the profile an easily identifiable name that references its intent.

3. Comments Field:
Enter any additional information that might be needed by administrators, as a reminder of the profile's purpose
and scope.

4. SSL Inspection Options:

a. Enable SSL Inspection of:
l Multiple Clients Connecting to Multiple Servers - Use this option for generic policies where the destination is

unknown.
l Protecting SSL Server - Use this option when setting up a profile customized for a specific SSL server with a

specific certificate.

b. Inspection Method
The options here are:

l SSL Certificate Inspection - only inspects the certificate, not the contents of the traffic.
l Full SSL Inspection - inspects all of the traffic.

c. CACertificate
Use the drop down menu to choose which one of the installed certificates to use for the inspection of the
packets or click on Download Certificate.

d. Untrusted SSL Certificates
Select an action for untrusted SSL certificates.

d. Protocol Port Mapping / Inspect All Ports
Enable the ability to inspect all ports by checking the box. If the feature is not enabled, specify in the field next
to the listed protocols, the port through which that protocols traffic will be inspected. Traffic of that protocol
going through any other port will not be inspected.

If you select Inspect All Ports, then only the IPS engine is used for inspection.

5. Exempt from SSL Inspection:
Use the dropdown menus in this section to specify any reputable websites, FortiGuard Web Categories, or
addresses will be exempt from SSL inspection.
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l Reputable Websites - Enable this option to exempt any websites identified by FortiGuard as reputable.
l Web Categories - By default the categories of Finance and Banking, Health and Wellness, and Personal

Privacy, have been added as these are one that are most likely to have applications that will require a specific
certificate.

l Addresses - These can be any of the Address objects that have an interface of "Any".
l Log SSL exemptions - Enable this option to log all SSL exemptions

6. SSH Inspection Options:

a. SSH Deep Scan
Toggle to disable or enable the feature

b. SSH Port
The available options are:

l Any - choosing this option will search all of the traffic regardless of service or TCP/IP port for packets that
conform to the SSH protocol

l Specify - choosing this option will restrict the search for SSH protocol packets to the TCP/IP port number
specified in the field. This is not as comprehensive but it is easier on the performance of the firewall.

d. Protocol Actions
l Exec - Block, Log or neither. Select using check boxes.
l Port-Forward - Block, Log or neither. Select using check boxes.
l SSH-Shell - Block, Log or neither. Select using check boxes.
l X11-Filter - Block, Log or neither. Select using check boxes.

6. Common Options:

a. Allow Invalid SSL Certificates
Check the box to enable the passing of traffic with invalid certificate

b. Log SSL anomalies
Check the box to allow the Logging function to record traffic sessions containing invalid certificates

The Full SSL Inspectionmethod is enabled by default when creating a new
SSL/SSH Inspection profile. There are situations were this feature can cause issues so
be sure that you would like it enabled before applying the inspection profile.

Secure white list database
You can enable a feature that gathers a list of reputable domain names that can be excluded from SSL deep
inspection. This list is periodically updated and downloaded to FortiGate units through FortiGuard.

Go to Security Profiles > SSL Inspection, enable Exempt from SSL Inspection, and enable Reputable
Websites.The reputable websites are rated by FortiGuard. Web Filtering.

CLI Syntax:
config firewall ssl-ssh-profile

edit deep-inspection
set whitelist enable

end
end
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SSL server table for SSL offloading
An SSL server table can now be used for SSL offloading. This feature was introduced with the release of FortiOS
5.4.0.

CLI Syntax

config firewall ssl-ssh-profile
edit <name>

set use-ssl-server {enable|disable}
next

end
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Creating a custom IPS signature
The FortiGate predefined signatures cover common attacks. If you use an unusual or specialized application or
an uncommon platform, add custom signatures based on the security alerts released by the application and
platform vendors.

You can add or edit custom signatures using the GUI or the CLI.

To create a custom signature

1. Go to Security Profiles > Intrusion Prevention.
2. Select [View IPS Signatures]
3. Select Create New to add a new custom signature.
4. Enter a Name for the custom signature.
5. Enter the Signature. For information about completing this field, see Custom signature syntax and Custom

signature keywords.
6. Select OK.

Custom signature syntax
All custom signatures follow a particular syntax. Each begins with a header and is followed by one or more
keywords. A custom signature definition is limited to a maximum length of 512 characters. A definition can be a
single line or span multiple lines connected by a backslash (\) at the end of each line.

A custom signature definition begins with a header, followed by a set of keyword/value pairs enclosed by
parenthesis [( )]. The keyword and value pairs are separated by a semi colon (;) and consist of a keyword and a
value separated by a space. The basic format of a definition is HEADER (KEYWORD VALUE;)

You can use as many keyword/value pairs as required within the 512 character limit. To configure a custom
signature, go to Security Profiles > Intrusion Prevention, select View IPS Signatures, select Create New,
and enter the data directly into the Signature field, following the guidance in the next topics.

The table below shows the valid characters and basic structure. For details about each keyword and its
associated values, see Custom signature keywords.

Valid syntax for custom signature fields

Field Valid Characters Usage

HEADER F-SBID The header for an attack
definition signature. Each
custom signature must begin
with this header.
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Field Valid Characters Usage

KEYWORD

Each keyword must start with a pair of dashes (--),
and consist of a string of 1 to 19 characters.

Normally, keywords are an English word or English
words connected by an underscore (_). Keywords are
case insensitive.

The keyword is used to identify
a parameter.

VALUE Double quotes (") must be used around the value if it
contains a space and/or a semicolon (;).

If the value is NULL, the space between the
KEYWORD and VALUE can be omitted.

Values are case sensitive.

Note: If double quotes are used for quoting the
value, the double quotes are not considered as part
of the value string.

The value is set specifically for
a parameter identified by a
keyword.

Custom signature keywords
l information
l session
l content
l IP header
l TCP header
l UDP header
l ICMP
l other

Information keywords

attack_id

Syntax: --attack_id <id_int>;

Description:

Use this optional value to identify the signature. It cannot be the same value as any other custom rules. If an
attack ID is not specified, the FortiGate automatically assigns an attack ID to the signature. If you are using
VDOMs, custom signatures appear only in the VDOM in which you create them. You can use the same attack
ID for signatures in different VDOMs.

An attack ID you assign must be between 1000 and 9999.

Example: --attack_id 1234;
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name

Syntax: --name <name_str>;

Description:

Enter the name of the rule. A rule name must be unique. If you are using VDOMs, custom signatures appear
only in the VDOM in which you create them. You can use the same rule name for signatures in different
VDOMs. The name you assign must be a string greater than 0 and less than 64 characters in length.

Example: --name "Buffer_Overflow";

Session keywords

flow

Syntax: --flow {from_client[,reversed] | from_server[,reversed] | bi_direction
};

Description:

Specify the traffic direction and state to be inspected. They can be used for all IP traffic.

Example: --src_port 41523; --flow bi_direction;

The signature checks traffic to and from port 41523.

If you enable “quarantine attacker”, the optional reversed keyword allows you to change the side of the
connection to be quarantined when the signature is detected.

For example, a custom signature written to detect a brute-force log in attack is triggered when “Login Failed” is
detected from_server more than 10 times in 5 seconds. If the attacker is quarantined, it is the server that is
quarantined in this instance. Adding reversed corrects this problem and quarantines the actual attacker.

Previous FortiOS versions used to_client and to_server values. These are now deprecated, but still function for
backwards compatibility.

service

Syntax: --service {HTTP | TELNET | FTP | DNS | SMTP | POP3 | IMAP | SNMP |
RADIUS | LDAP | MSSQL | RPC | SIP | H323 | NBSS | DCERPC | SSH | SSL};

Description:

Specify the protocol type to be inspected. This keyword allows you to specify the traffic type by protocol rather
than by port. If the decoder has the capability to identify the protocol on any port, the signature can be used to
detect the attack no matter what port the service is running on. Currently, HTTP, SIP, SSL, and SSH protocols
can be identified on any port based on the content.

app_cat

Syntax: --app_cat <category_int>;

Description:
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Specify the category of the application signature. Signatures with this keyword are considered as application
rules. These signatures will appear under Application Control instead of IPS configuration. To display a complete
list of application signature categories, enter the following CLI commands:

config application list
edit default

config entries
edit 1

set category ?

weight

Syntax: --weight <weight_int>;

Description:

Specify the weight to be assigned to the signature. This keyword allows a signature with the higher weight to
have priority over a signature with a lower weight. This is useful to prioritize between custom and stock
signatures and also between different custom signatures.

The weight must be between 0 an 255. Most of the signatures in the Application Control signature database
have weights of 10; botnet signatures are set to 250. A range of 20 to 50 is recommended for custom
signatures.

Content keywords

byte_extract

Syntax: byte_extract:<bytes_to_extract>, <offset>, <name> \ [, relative][,
multiplier <multiplier value>][, <endian>]\ [, string][, hex][, dec][, oct][,
align <align value>][, dce];

Description:

Use the byte_extract option to write rules against length-encoded protocols. This reads some of the bytes
from the packet payload and saves it to a variable.

byte_jump

Syntax: --byte_jump <bytes_to_convert>, <offset>[, multiplier][, relative] [,
big] [, little] [, string] [, hex] [, dec] [, oct] [, align];

Description:

Use the byte_jump option to extract a number of bytes from a packet, convert them to their numeric
representation, and jump the match reference up that many bytes (for further pattern matching or byte
testing). This keyword allows relative pattern matches to take into account numerical values found in network
data. The available keyword options include:

l <bytes_to_convert>: The number of bytes to examine from the packet.
l <offset>: The number of bytes into the payload to start processing.
l [multiplier]: multiplier is optional. It must be a numerical value when present. The converted value multiplied

by the number is the result to be skipped.
l relative: Use an offset relative to last pattern match.
l big: Process the data as big endian (default).
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l little: Process the data as little endian.
l string: The data is a string in the packet.
l hex: The converted string data is represented in hexadecimal notation.
l dec: The converted string data is represented in decimal notation.
l oct: The converted string data is represented in octal notation.
l align: Round up the number of converted bytes to the next 32-bit boundary.

byte_test

Syntax: --byte_test <bytes_to_convert>, <operator>, <value>, <offset>
[multiplier][, relative] [, big] [, little] [, string] [, hex] [, dec] [,
oct];

Description:

Use the byte_test keyword to compare a byte field against a specific value (with operator). This keyword is
capable of testing binary values or converting representative byte strings to their binary equivalent and testing
them. The available keyword options include:

l <bytes_to_convert>: The number of bytes to compare.
l <operator>: The operation to perform when comparing the value (<,>,=,!,&).
l <value>: The value to compare the converted value against.
l <offset>: The number of bytes into the payload to start processing.
l [multiplier]: multiplier is optional. It must be a numerical value when present. The converted value multiplied

by the number is the result to be skipped.
l relative: Use an offset relative to last pattern match.
l big: Process the data as big endian (default).
l little: Process the data as little endian.
l string: The data is a string in the packet.
l hex: The converted string data is represented in hexadecimal notation.
l dec: The converted string data is represented in decimal notation.
l oct: The converted string data is represented in octal notation.

depth

Syntax: --depth <depth_int>;

Description:

Use the depth keyword to search for the contents within the specified number of bytes after the starting point
defined by the offset keyword. If no offset is specified, the offset is assumed to be equal to 0.

If the value of the depth keyword is smaller than the length of the value of the content keyword, this signature
will never be matched.

The depth must be between 0 and 65535.

distance

Syntax: --distance <dist_int>;

Description:
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Use the distance keyword to search for the contents within the specified number of bytes relative to the end of
the previously matched contents. If the within keyword is not specified, continue looking for a match until the
end of the payload.

The distance must be between 0 and 65535.

content

Syntax: --content [!]"<content_str>";

Description:

Deprecated, see pattern and context keywords. Use the content keyword to search for the content string in the
packet payload. The content string must be enclosed in double quotes.

To have the FortiGate search for a packet that does not contain the specified context string, add an
exclamation mark (!) before the content string.

Multiple content items can be specified in one rule. The value can contain mixed text and binary data. The
binary data is generally enclosed within the pipe (|) character.

The double quote ("), pipe sign(|) and colon(:) characters must be escaped using a back slash if specified in a
content string.

If the value of the content keyword is greater than the length of the value of the depth keyword, this signature
will never be matched.

context

Syntax: --context {uri | header | body | host};

Description:

Specify the protocol field to look for the pattern. If context is not specified for a pattern, the FortiGate unit
searches for the pattern anywhere in the packet buffer. The available context variables are:

l uri: Search for the pattern in the HTTPURI line.
l header: Search for the pattern in HTTP header lines or SMTP/POP3/SMTP control messages.
l body: Search for the pattern in HTTP body or SMTP/POP3/SMTP email body.
l host: Search for the pattern in HTTPHOST line.

no_case

Syntax: --no_case;

Description:

Use the no-case keyword to force the FortiGate unit to perform a case-insensitive pattern match.

offset

Syntax: --offset <offset_int>;

Description:

Use the offset keyword to look for the contents after the specified number of bytes into the payload. The
specified number of bytes is an absolute value in the payload. Follow the offset keyword with the depth
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keyword to stop looking for a match after a specified number of bytes. If no depth is specified, the FortiGate
unit continues looking for a match until the end of the payload.

The offset must be between 0 and 65535.

pattern

Syntax: --pattern [!]"<pattern_str>";

Description:

The FortiGate unit will search for the specified pattern. A pattern keyword normally is followed by a context
keyword to define where to look for the pattern in the packet. If a context keyword is not present, the FortiGate
unit looks for the pattern anywhere in the packet buffer. To have the FortiGate search for a packet that does
not contain the specified URI, add an exclamation mark (!) before the URI.

Example: --pattern "/level/" --pattern "|E8 D9FF FFFF|/bin/sh" --pattern
!"|20|RTSP/"

pcre

Syntax: --pcre [!]"/<regex>/[ismxAEGRUB]";

Description:

Similarly to the pattern keyword, use the pcre keyword to specify a pattern using Perl-compatible regular
expressions (PCRE). A pcre keyword can be followed by a context keyword to define where to look for the
pattern in the packet. If no context keyword is present, the FortiGate unit looks for the pattern anywhere in the
packet buffer.

For more information about PCRE syntax, go to http://www.pcre.org.

The switches include:

l i: Case insensitive.
l s: Include newlines in the dot metacharacter.
l m: By default, the string is treated as one big line of characters. ^ and $ match at the beginning and ending of the

string. When m is set, ^ and $ match immediately following or immediately before any newline in the buffer, as well
as the very start and very end of the buffer.

l x: White space data characters in the pattern are ignored except when escaped or inside a character class.
l A: The pattern must match only at the start of the buffer (same as ^ ).
l E: Set $ to match only at the end of the subject string. Without E, $ also matches immediately before the final

character if it is a newline (but not before any other newlines).
l G: Invert the “greediness” of the quantifiers so that they are not greedy by default, but become greedy if followed by

?.
l R: Match relative to the end of the last pattern match. (Similar to distance:0;).
l U: Deprecated, see the context keyword. Match the decoded URI buffers.

uri

Syntax: --uri [!]"<uri_str>";

Description:
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Deprecated, see pattern and context keywords. Use the uri keyword to search for the URI in the packet
payload. The URI must be enclosed in double quotes ("). To have the FortiGate unit search for a packet that
does not contain the specified URI, add an exclamation mark (!) before the URI. Multiple content items can be
specified in one rule. The value can contain mixed text and binary data. The binary data is generally enclosed
within the pipe (|) character. The double quote ("), pipe sign (|) and colon (:) characters must be escaped using
a back slash (\) if specified in a URI string.

within

Syntax: --within <within_int>;

Description:

Use this together with the distance keyword to search for the contents within the specified number of bytes of
the payload.

The within value must be between 0 and 65535.

IP header keywords

dst_addr

Syntax: --dst_addr [!]<ipv4>;

Description:

Use the dst_addr keyword to search for the destination IP address. To have the FortiGate search for a packet
that does not contain the specified address, add an exclamation mark (!) before the IP address. You can define
up to 28 IP addresses or CIDR blocks. Enclose the comma separated list in square brackets.

Example: dst_addr [172.20.0.0/16, 10.1.0.0/16,192.168.0.0/16]

ip_dscp

Syntax: --ip_dscp

Description:

Use the ip_dscp keyword to check the IP DSCP field for the specified value.

ip_id

Syntax: --ip_id <field_int>;

Description:

Check the IP ID field for the specified value.

ip_option

Syntax: --ip_option {rr | eol | nop | ts | sec | lsrr | ssrr | satid | any};

Description:

Use the ip_option keyword to check various IP option settings.

The available options include:
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l rr: Check if IP RR (record route) option is present.
l eol: Check if IP EOL (end of list) option is present.
l nop: Check if IP NOP (no op) option is present.
l ts: Check if IP TS (time stamp) option is present.
l sec: Check if IP SEC (IP security) option is present.
l lsrr: Check if IP LSRR (loose source routing) option is present.
l ssrr: Check if IP SSRR (strict source routing) option is present.
l satid: Check if IP SATID (stream identifier) option is present.
l any: Check if IP any option is present.

ip_tos

Syntax: --ip_tos <field_int>;

Description:

Check the IP TOS field for the specified value.

ip_ttl

Syntax: --ip_ttl [< | >] <ttl_int>;

Description:

Check the IP time-to-live value against the specified value. Optionally, you can check for an IP time-to-live
greater-than (>) or less-than (<) the specified value with the appropriate symbol.

protocol

Syntax: --protocol {<protocol_int> | tcp | udp | icmp};

Description:

Check the IP protocol header.

Example: --protocol tcp;

src_addr

Syntax: --src_addr [!]<ipv4>;

Description:

Use the src_addr keyword to search for the source IP address. To have the FortiGate unit search for a packet
that does not contain the specified address, add an exclamation mark (!) before the IP address. You can define
up to 28 IP addresses or CIDR blocks. Enclose the comma separated list in square brackets.

Example: src_addr 192.168.13.0/24

TCP header keywords

ack

Syntax: --ack <ack_int>;

Description:
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Check for the specified TCP acknowledge number.

dst_port

Syntax: --dst_port [!]{<port_int> | :<port_int> | <port_int>: | <port_
int>:<port_int>};

Description:

Use the dst_port keyword to specify the destination port number.

You can specify a single port or port range:

l <port_int> is a single port.
l :<port_int> includes the specified port and all lower numbered ports.
l <port_int>: includes the specified port and all higher numbered ports.
l <port_int>:<port_int> includes the two specified ports and all ports in between.

seq

Syntax: --seq [operator,]<number>[,relative];

Description:

Check for the specified TCP sequence number.

l operator includes =,<,>,!.
l relative indicates it’s relative to the initial sequence number of the TCP session.

src_port

Syntax: --src_port [!]{<port_int> | :<port_int> | <port_int>: | <port_
int>:<port_int>};

Description:

Use the src_port keyword to specify the source port number. You can specify a single port or port range:

l <port_int> is a single port.
l :<port_int> includes the specified port and all lower numbered ports.
l <port_int>: includes the specified port and all higher numbered ports.
l <port_int>:<port_int> includes the two specified ports and all ports in between.

tcp_flags

Syntax: --tcp_flags <SAFRUP120>[!|*|+] [,<SAFRUP120>];

Description:

Specify the TCP flags to match in a packet.

l S: Match the SYN flag.
l A: Match the ACK flag.
l F: Match the FIN flag.
l R: Match the RST flag.
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l U: Match the URG flag.
l P: Match the PSH flag.
l 1: Match Reserved bit 1.
l 2: Match Reserved bit 2.
l 0: Match No TCP flags set.
l !: Match if the specified bits are not set.
l *: Match if any of the specified bits are set.
l +: Match on the specified bits, plus any others.

The first part if the value (<SAFRUP120>) defines the bits that must be present for a successful match.

Example:

--tcp_flags AP only matches the case where both A and P bits are set.

The second part ([,<SAFRUP120>]) is optional, and defines the additional bits that can be present for a
match.

For example tcp_flags S,12 matches the following combinations of flags: S, S and 1, S and 2, S and 1
and 2. The modifiers !, * and + cannot be used in the second part.

window_size

Syntax: --window_size [!]<window_int>;

Description:

Check for the specified TCPwindow size. You can specify the window size as a hexadecimal or decimal
integer. A hexadecimal value must be preceded by 0x. To have the FortiGate search for the absence of the
specified window size, add an exclamation mark (!) before the window size.

UDP header keywords

dst_port

Syntax: --dst_port [!]{<port_int> | :<port_int> | <port_int>: | <port_
int>:<port_int>};

Description:

Specify the destination port number. You can specify a single port or port range:

l <port_int> is a single port.
l :<port_int> includes the specified port and all lower numbered ports.
l <port_int>: includes the specified port and all higher numbered ports.
l <port_int>:<port_int> includes the two specified ports and all ports in between.

src_port

Syntax: --src_port [!]{<port_int> | :<port_int> | <port_int>: | <port_
int>:<port_int>};

Description:

Specify the destination port number. You can specify a single port or port range:
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l <port_int> is a single port.
l :<port_int> includes the specified port and all lower numbered ports.
l <port_int>: includes the specified port and all higher numbered ports.
l <port_int>:<port_int> includes the two specified ports and all ports in between.

ICMP keywords

icmp_code

Syntax: --icmp_code <code_int>;

Description:

Specify the ICMP code to match.

icmp_id

Syntax: --icmp_id <id_int>;

Description:

Check for the specified ICMP ID value.

icmp_seq

Syntax: --icmp_seq <seq_int>;

Description:

Check for the specified ICMP sequence value.

icmp_type

Syntax: --icmp_type <type_int>;

Description:

Specify the ICMP type to match.

Other keywords

data_size

Syntax: --data_size {<size_int> | <<size_int> | ><size_int>;

Description:

Test the packet payload size. With data_size specified, packet reassembly is turned off automatically. So a
signature with data_size and only_stream values set is wrong.

l <size_int> is a particular packet size.
l <<size_int> is a packet smaller than the specified size.
l ><size_int> is a packet larger than the specified size.

Examples:

2946 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Custom Application & IPS Signatures

l --data_size 300;

l --data_size <300;

l --data_size >300;

data_at

Syntax: --data_at <offset_int>[, relative];

Description:

Verify that the payload has data at a specified offset, optionally looking for data relative to the end of the
previous content match.

dump-all-html

Syntax: --dump-all-html

Description:

Dump all HTML files for benchmarking via iSniff. When there is no file type specified, all HTML files are
dumped.

rate

Syntax: --rate <matches_int>,<time_int>;

Description:

Instead of generating log entries every time the signature is detected, use this keyword to generate a log entry
only if the signature is detected a specified number of times within a specified time period.

l <matches_int> is the number of times a signature must be detected.
l <time_int> is the length of time in which the signature must be detected, in seconds.

For example, if a custom signature detects a pattern, a log entry will be created every time the signature is
detected. If --rate 100,10; is added to the signature, a log entry will be created if the signature is
detected 100 times in the previous 10 seconds. Use this command with --track to further limit log entries to
when the specified number of detections occur within a certain time period involving the same source or
destination address rather than all addresses.

rpc_num

Syntax: --rpc_num <app_int>[, <ver_int> | *][, <proc_int> | *>];

Description:

Check for RPC application, version, and procedure numbers in SUNRPC CALL requests. The * wild card can
be used for version and procedure numbers.

same_ip

Syntax: --same_ip;

Description:

Check that the source and the destination have the same IP addresses.
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track

Syntax: --track {SRC_IP |DST_IP |DHCP_CLIENT |DNS_DOMAIN}[,block_int];

Description:

When used with --rate, this keyword narrows the custom signature rate totals to individual addresses.

l SRC_IP:  tracks the packet's source IP.
l DST_IP:  tracks the packet's destination IP.
l DHCP_CLIENT:  tracks the DHCP client's MAC address.
l DNS_DOMAIN:  counts the number of any specific domain name.
l block_int has the FortiGate unit block connections for the specified number of seconds, from the client or to the

server, depending on which is specified.

For example, if --rate 100,10 is added to the signature, a log entry will be created if the signature is
detected 100 times in the previous 10 seconds. The FortiGate unit maintains a single total, regardless of
source and destination address.

If the same custom signature also includes --track client; matches are totaled separately for each source
address. A log entry is added when the signature is detected 100 times in 10 seconds within traffic from the
same source address.

The --track keyword can also be used without --rate. If an integer is specified, the client or server will be
blocked for the specified number of seconds every time the signature is detected.

Creating a custom signature to block access to example.com
In this first example, you will create a custom signature to block access to the example.com URL.

This example describes the use of the custom signature syntax to block access to a URL. To create the custom
signature entry in the FortiGate's GUI, see Custom Application & IPS Signatures.

1. Enter the custom signature basic format.
All custom signatures have a header and at least one keyword/value pair. The header is always the
same:

F-SBID( )

The keyword/value pairs appear within the parentheses and each pair is followed by a semicolon.

2. Choose a name for the custom signature
Every custom signature requires a name, so it is a good practice to assign a name before adding any
other keywords.Use the --name keyword to assign the custom signature a name. The name value
follows the keyword after a space. Enclose the name value in double-quotes:

F-SBID( --name "Block.example.com"; )

The signature, as it appears here, will not do anything if you try to use it. It has a name, but does not
look for any patterns in network traffic. You must specify a pattern that the FortiGate unit will search
for.

3. Add a signature pattern
Use the --pattern keyword to specify what the FortiGate unit will search for:

F-SBID( --name "Block.example.com"; --pattern "example.com"; )

The signature will now detect the example.com URL appearing in network traffic. The custom
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signature should only detect the URL in HTTP traffic, however. Any other traffic with the URL should
be allowed to pass. For example, an email message to or from example.com should not be stopped.

4. Specify the service
Use the --service keyword to limit the effect of the custom signature to only the HTTP protocol.

F-SBID( --name "Block.example.com"; --pattern "example.com"; --service HTTP; )

The FortiGate unit will limit its search for the pattern to the HTTP protocol. Even though the HTTP
protocol uses only TCP traffic, the FortiGate will search for HTTP protocol communication in TCP,
UDP, and ICMP traffic. This is a waste of system resources that you can avoid by limiting the search
further, as shown below.

5. Specify the traffic type.
Use the --protocol tcp keyword to limit the effect of the custom signature to only TCP
traffic. This will save system resources by not unnecessarily scanning UDP and ICMP traffic.

F-SBID( --name "Block.example.com"; --pattern "example.com"; --service HTTP; --
protocol tcp; )

The FortiGate unit will limit its search for the pattern to TCP traffic and ignore UDP and ICMP network
traffic.

6. Ignore case sensitivity
By default, patterns are case sensitive. If a user directed his or her browser to Example.com, the
custom signature would not recognize the URL as a match.

Use the --no_case keyword to make the pattern matching case insensitive.

F-SBID( --name "Block.example.com"; --pattern "example.com"; --service HTTP; --
protocol tcp; --no_case; )

Unlike all of the other keywords in this example, the --no_case keyword has no value. Only the
keyword is required.

7. Limit pattern scans to only traffic sent from the client
The --flow command can be used to further limit the network traffic being scanned to only that
send by the client or by the server.

F-SBID( --name "Block.example.com"; --pattern "example.com"; --service HTTP; --
protocol tcp; --no_case; --flow from_client; )

Web servers do not contact clients until clients first open a communication session. Therefore, using
the --flow from_client command will force the FortiGate to ignore all traffic from the server.
Since the majority of HTTP traffic flows from the server to the client, this will save considerable
system resources and still maintain protection.

8. Specify the context
When the client browser tries to contact example.com, a DNS is first consulted to get the
example.com server IP address. The IP address is then specified in the URL field of the HTTP
communication. The domain name will still appear in the host field, so this custom signature will not
function without the --context host keyword/value pair.

F-SBID( --name "Block.example.com"; --pattern "example.com"; --service HTTP; --no_
case; --flow from_client; --context host; )
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Creating a custom signature to block the SMTP “vrfy” command
The SMTP “vrfy” command can be used to verify the existence of a single email address or to list all of the valid
email accounts on an email server. A spammer could potentially use this command to obtain a list of all valid
email users and direct spam to their inboxes.

In this example, you will create a custom signature to block the use of the vrfy command. Since the custom
signature blocks the vrfy command from coming through the FortiGate unit, the administrator can still use the
command on the internal network.

This example describes the use of the custom signature syntax to block the vrfy command. To create the custom
signature entry in the FortiGate's GUI, see Custom Application & IPS Signatures.

1. Enter the custom signature basic format
All custom signatures have a header and at least one keyword/value pair. The header is always the
same:

F-SBID( )

The keyword/value pairs appear within the parentheses and each pair is followed by a semicolon.

2. Choose a name for the custom signature
Every custom signature requires a name, so it is a good practice to assign a name before you add any
other keywords.

Use the --name keyword to assign the custom signature a name. The name value follows the
keyword after a space. Enclose the name value in double-quotes:

F-SBID( --name "Block.SMTP.VRFY.CMD"; )

The signature, as it appears here, will not do anything if you try to use it. It has a name, but does not
look for any patterns in network traffic. You must specify a pattern that the FortiGate unit will search
for.

3. Add a signature pattern
Use the --pattern keyword to specify what the FortiGate unit will search for:

F-SBID( --name "Block.SMTP.VRFY.CMD"; --pattern "vrfy"; )

The signature will now detect the vrfy command appearing in network traffic. The custom signature
should only detect the command in SMTP traffic, however. Any other traffic with the pattern should be
allowed to pass. For example, an email message discussing the vrfy command should not be
stopped.

4. Specify the service.
Use the --service keyword to limit the effect of the custom signature to only the HTTP protocol.

F-SBID( --name "Block.SMTP.VRFY.CMD"; --pattern "vrfy"; --service SMTP; )

The FortiGate unit will limit its search for the pattern to the SMTP protocol.

Even though the SMTP protocol uses only TCP traffic, the FortiGate will search for SMTP protocol
communication in TCP, UDP, and ICMP traffic. This is a waste of system resources that you can
avoid by limiting the search further, as shown below.

5. Specify the traffic type.
Use the --protocol tcp keyword to limit the effect of the custom signature to only TCP traffic.
This will save system resources by not unnecessarily scanning UDP and ICMP traffic.
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F-SBID( --name "Block.SMTP.VRFY.CMD"; --pattern "vrfy"; --service SMTP; --
protocol tcp; )

The FortiGate unit will limit its search for the pattern to TCP traffic and ignore the pattern in UDP and
ICMP network traffic.

6. Ignore case sensitivity.
By default, patterns are case sensitive. If a user directed his or her browser to Example.com, the
custom signature would not recognize the URL as a match.

Use the --no_case keyword to make the pattern matching case insensitive.

F-SBID( --name "Block.SMTP.VRFY.CMD"; --pattern "vrfy"; --service SMTP; --no_case; )

Unlike all of the other keywords in this example, the --no_case keyword has no value. Only the
keyword is required.

7. Specify the context.
The SMTP vrfy command will appear in the SMTP header. The --context host keyword/value
pair allows you to limit the pattern search to only the header.

F-SBID( --name "Block.SMTP.VRFY.CMD"; --pattern "vrfy"; --service SMTP; --no_case; -
-context header; )

Creating a custom signature to block files according to the file's hash value
In this example, you will create a custom signature that allows you to specify a hash value (or checksum) of a file
that you want to block. To block multiple files you can create a custom signature for each file with that file's hash
value in it and then add all of the custom signatures to an IPS sensor and set the action to block for each one.
When IPS encounters a file with a matching hash value the file is blocked.

This example uses a CRC32 checksum of the file as the hash value of the file to be blocked. You can use any
utility that supports CRC32 checksums to generate the hash value.

1. Enter the custom signature basic format.
All custom signatures have a header and at least one keyword/value pair. The header is always the
same:

F-SBID( )

The keyword/value pairs appear within the parentheses and each pair is followed by a semicolon.

2. Choose a name for the custom signature
Every custom signature requires a name, so it is a good practice to assign a name before adding any
other keywords. Use the --name keyword to assign the custom signature a name. The name value
follows the keyword after a space. Enclose the name value in double-quotes:

F-SBID( --name "File.Hash.Example"; )

The signature, as it appears here, will not do anything if you try to use it. It has a name, but does not
look for any patterns in network traffic.

3. Specify the traffic type.
Use the --protocol tcp keyword to limit the effect of the custom signature to only TCP
traffic. This will save system resources by not unnecessarily scanning UDP and ICMP traffic.

F-SBID( --name "File.Hash.Example"; --protocol tcp; )

The FortiGate unit will limit its search for the pattern to TCP traffic and ignore UDP and ICMP network
traffic.
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4. Add the CRC32 hash value.
Use the --crc32 keyword. This indicates that the value that follows is a hexadecimal number that
represents the CRC32 checksum of the file. The --crc32 keyword also requires that you include the
file length. The syntax is --crc32 <checksum>,<file-length>;. The following example
shows the syntax for a file with checksum 51480492 and file length 822.

F-SBID( --name "File.Hash.Example"; --protocol tcp; --crc32 51480492,822; )
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The following topics are included in this section:

l Security Profiles and Virtual domains (VDOMs)
l Conserve mode
l Using wildcards and Perl regular expressions
l Adding External Security Devices
l CPU allocation and tuning commands to survive reboot

Security Profiles and Virtual domains (VDOMs)
If you enable virtual domains (VDOMs) on your FortiGate unit, any Security Profiles configuration is limited to the
VDOM in which you configure it.

While configuration is not shared, the various databases used by Security Profiles features are shared. The
FortiGuard antivirus and IPS databases and updates to the databases are shared. The FortiGuard web filter and
spam filter features access the FortiGuard distribution network and read the same information when checking
email for spam and web site categories and classification.

Conserve mode
FortiGate units perform all Security Profiles processing in physical RAM. Since each model has a limited amount
of memory, conserve mode is activated when the remaining free memory is nearly exhausted or the AV proxy has
reached the maximum number of sessions it can service. While conserve mode is active, the AV proxy does not
accept new sessions.

A warning will appear in the top bar of the FortiGate, regardless of which page in the FortiGate GUI you are on.

The AV proxy

Most content inspection the FortiGate unit performs requires that the files, email messages, URLs, and web
pages be buffered and examined as a whole. The AV proxy performs this function, and because it may be
buffering many files at the same time, it uses a significant amount of memory. Conserve mode is designed to
prevent all the component features of the FortiGate unit from trying to use more memory than it has. Because the
AV proxy uses so much memory, conserve mode effectively disables it in most circumstances. As a result, the
content inspection features that use the AV proxy are also disabled in conserve mode.

All of the Security Profiles features use the AV proxy with the exception of IPS, application control, DoS as well as
flow-based antivirus, DLP, and web filter scanning. These features continue to operate normally when the
FortiGate unit enters conserve mode.

Entering and exiting conserve mode

A FortiGate unit will enter conserve mode because it is nearly out of physical memory, or because the AV proxy
has reached the maximum number of sessions it can service. The memory threshold that triggers conserve mode
varies by model, but it is about 20% free memory. When memory use rises to the point where less than 20% of
the physical memory is free, the FortiGate unit enters conserve mode.
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The FortiGate unit will leave conserve mode only when the available physical memory exceeds about 30%. When
exiting conserve mode, all new sessions configured to be scanned with features requiring the AV proxy will be
scanned as normal, with the exception of a unit configured with the one-shot option.

Conserve mode effects

What happens when the FortiGate unit enters conserve mode depends on how you have av-failopen
configured. There are four options:

off

The off setting forces the FortiGate unit to stop all traffic that is configured for content inspection by Security
Profiles features that use the AV proxy. New sessions are not allowed but current sessions continue to be
processed normally unless they request more memory. Sessions requesting more memory are terminated.

For example, if a security policy is configured to use antivirus scanning, the traffic it permits is blocked while in
conserve mode. A policy with IPS scanning enabled continues as normal. A policy with both IPS and antivirus
scanning is blocked because antivirus scanning requires the AV proxy.

Use the off setting when security is more important than a loss of access while the problem is rectified.

pass

The pass setting allows traffic to bypass the AV proxy and continue to its destination. Since the traffic is
bypassing the proxy, no Security Profiles scanning that requires the AV proxy is performed. Security Profiles
scanning that does not require the AV proxy continues normally.

Use the pass setting when access is more important than security while the problem is rectified.

Pass is the default setting.

one-shot

The one-shot setting is similar to pass in that traffic is allowed when conserve mode is active. The difference is
that a system configured for one-shot will force new sessions to bypass the AV proxy even after it leaves conserve
mode. The FortiGate unit resumes use of the AV proxy only when the av-failopen setting is changed or the
unit is restarted.

idledrop

The idledrop setting will recover memory and session space by terminating all the sessions associated with the
host that has the most sessions open. The FortiGate may force this session termination a number of times, until
enough memory is available to allow it to leave conserve mode.

The idledrop setting is primarily designed for situations in which malware may continue to open sessions until the
AV proxy cannot accept more new sessions, triggering conserve mode. If your FortiGate unit is operating near
capacity, this setting could cause the termination of valid sessions. Use this option with caution.

Configuring the av-failopen command

You can configure the av-failopen command using the CLI.

config system global
set av-failopen {off | pass | one-shot | idledrop}

end
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The default setting is pass.

Using wildcards and Perl regular expressions
Many Security Profiles feature list entries can include wildcards or Perl regular expressions.

For more information about using Perl regular expressions, see http://perldoc.perl.org/perlretut.html.

Regular expression vs. wildcard match pattern

Awildcard character is a special character that represents one or more other characters. The most commonly
used wildcard characters are the asterisk (*), which typically represents zero or more characters in a string of
characters, and the question mark (?), which typically represents any one character.

In Perl regular expressions, the ‘.’ character refers to any single character. It is similar to the ‘?’ character in
wildcard match pattern. As a result:

l example.com not only matches example.com but also examplea.com, exampleb.com, examplec.com, and so on.

To add a question mark (?) character to a regular expression from the FortiGate CLI,
enter Ctrl+V followed by ?. To add a single backslash character (\) to a regular
expression from the CLI you must add precede it with another backslash character.
For example, example\\.com.

To match a special character such as '.' and ‘*’ use the escape character ‘\’. For example:

l To match example.com, the regular expression should be: example\.com

In Perl regular expressions, ‘*’ means match 0 or more times of the character before it, not 0 or more times of any
character. For example:

l exam*.com matches exammmm.com but does not match example.com

To match any character 0 or more times, use ‘.*’ where ‘.’ means any character and the ‘*’ means 0 or more
times. For example, the wildcard match pattern exam*.com should be exam.*\.com.

Word boundary

In Perl regular expressions, the pattern does not have an implicit word boundary. For example, the regular
expression “test” not only matches the word “test” but also any word that contains “test” such as “atest”, “mytest”,
“testimony”, “atestb”. The notation “\b” specifies the word boundary. To match exactly the word “test”, the
expression should be \btest\b.

Case sensitivity

Regular expression pattern matching is case sensitive in the web and Email Filter filters. To make a word or
phrase case insensitive, use the regular expression /i. For example, /bad language/i will block all
instances of “bad language”, regardless of case.

Perl regular expression formats

The following table lists and describes some example Perl regular expressions.
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Perl regular expression formats

Expression Matches

abc “abc” (the exact character sequence, but anywhere in the string)

^abc “abc” at the beginning of the string

abc$ “abc” at the end of the string

a|b Either “a” or “b”

^abc|abc$ The string “abc” at the beginning or at the end of the string

ab{2,4}c “a” followed by two, three or four “b”s followed by a “c”

ab{2,}c “a” followed by at least two “b”s followed by a “c”

ab*c “a” followed by any number (zero or more) of “b”s followed by a “c”

ab+c “a” followed by one or more b's followed by a c

ab?c “a” followed by an optional “b” followed by a” c”; that is, either “abc” or ”ac”

a.c “a” followed by any single character (not newline) followed by a” c “

a\.c “a.c” exactly

[abc] Any one of “a”, “b” and “c”

[Aa]bc Either of “Abc” and “abc”

[abc]+ Any (nonempty) string of “a”s, “b”s and “c”s (such as “a”, “abba”, ”acbabcacaa”)

[^abc]+ Any (nonempty) string which does not contain any of “a”, “b”, and “c” (such as “defg”)

\d\d Any two decimal digits, such as 42; same as \d{2}

/i Makes the pattern case insensitive. For example, /bad language/i blocks any
instance of bad language regardless of case.

\w+ A “word”: A nonempty sequence of alphanumeric characters and low lines
(underscores), such as foo and 12bar8 and foo_1

100\s*mk The strings “100” and “mk” optionally separated by any amount of white space
(spaces, tabs, newlines)

abc\b “abc” when followed by a word boundary (for example, in “abc!” but not in “abcd”)
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Expression Matches

perl\B “perl” when not followed by a word boundary (for example, in “perlert” but not in “perl
stuff”)

\x Tells the regular expression parser to ignore white space that is neither preceded by a
backslash character nor within a character class. Use this to break up a regular
expression into (slightly) more readable parts.

/x

Used to add regular expressions within other text. If the first character in a pattern is
forward slash '/', the '/' is treated as the delimiter. The pattern must contain a second
'/'. The pattern between ‘/’ will be taken as a regular expressions, and anything after
the second ‘/’ will be parsed as a list of regular expression options ('i', 'x', etc). An error
occurs if the second '/' is missing. In regular expressions, the leading and trailing space
is treated as part of the regular expression.

Examples of regular expressions

Block any word in a phrase

/block|any|word/

Block purposely misspelled words

Spammers often insert other characters between the letters of a word to fool spam blocking software.

/^.*v.*i.*a.*g.*r.*o.*$/i
/cr[eéèêë][\+\-\*=<>\.\,;!\?%&§@\^°\$£€\{\}()\[\]\|\\_01]dit/i

Block common spam phrases

The following phrases are some examples of common phrases found in spam messages.

/try it for free/i
/student loans/i
/you’re already approved/i
/special[\+\-\*=<>\.\,;!\?%&~#§@\^°\$£€\{\}()\[\]\|\\_1]offer/i

Adding External Security Devices

(missing or bad snippet)
 For more information on this configuration and others, see the FortiWeb Administration Guide.

CPU allocation and tuning commands to survive reboot
CPU affinity, whereby a process will execute on a specific CPU, can be changed so it survives a reboot.

CLI Syntax:

config system global
set av-affinity
set ips-affinity
set miglog-affinity

end
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av-affinity: Affinity setting for AV scanning (64-bit hexadecimal value in the format of xxxxxxxx_xxxxxxxx).

ips-affinity: Affinity setting for IPS (64-bit hexadecimal value in the format of xxxxxxxx_xxxxxxxx; allowed
CPUs must be less than total number of IPS engine daemons). This option is only available if the FortiGate
includes NP6 processors and support NTurbo.

miglog-affinity: Affinity setting for logging (64-bit hexadecimal value in the format of xxxxxxxx_xxxxxxxx).

Excluding industrial IP signatures
To reduce performance impacts caused by industrial IP signatures, the admin can choose to exclude the
industrial signatures when they are loaded by IPS; the industrial signatures then become inactive as a result. The
following CLI command has been restored for this purpose.

Syntax

config ips global
set exclude-signatures {none | industrial}

end
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Chapter 26 - Server Load Balancing

Server load balancing

FortiOS server load balancing includes the features you would expect of any server load balancing solution.
Traffic can be distributed across multiple backend servers based on multiple methods including static (failover),
round robin, weighted to account for different sized servers, or based on the health and performance of the server
including round trip time, number of connections. The load balancer supports HTTP, HTTPS, IMAPS, POP3S,
SMTPS, SSL or generic TCP/UDP or IP protocols. Session persistence is supported based on the SSL session ID
or based on an injected HTTP cookie.

Before you begin
Before you can configure server load balancing on the GUI go to System > Feature Visibility and turn on Load
Balance. Its in the Additional Features list.

To be able to use all of the features described in this chapter you should go to System > Settings and setting
the Inspection Mode to Proxy. If Inspection mode is set to Flow-based, you can only configure Virtual
Servers with Type set to HTTP, TCP, UDP, or IP. Proxy mode is required for persistence, HTTPMultiplexing,
SSL offloading and other advanced HTTP and SSL features.

How this chapter is organized
This document contains detailed information about how to configure FortiOS server load balancing to load
balance various types of traffic to multiple backend servers. This document describes all server load balancing
configuration options and contains detailed configuration examples.

This FortiOS Handbook chapter contains the following sections:

Inside FortiOS: Server Load Balancing highlights the features and benefits of FortiOS server load balancing.

Basic load balancing configuration example introduces FortiOS server load balancing by providing a basic
configuration example.

Configuring load balancing describes how to configure FortiOS server load balancing.

HTTP and HTTPS load balancing, multiplexing, and persistence describes FortiOS server load balancing features
that support load balancing HTTP and HTTPS sessions.

SSL/TLS load balancingdescribes FortiOS server load balancing features that support load balancing SSL and
TLS sessions.

IP, TCP, and UDP load balancing describes FortiOS server load balancing features that support load balancing
IP, TCP, and UDP sessions.

The following configuration examples are also included:

l Example HTTP load balancing to three real web servers
l Example Basic IP load balancing configuration
l Example Adding a server load balance port forwarding virtual IP
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l Example Weighted load balancing configuration
l Example HTTP and HTTPS persistence configuration

What's new for server load balancing in FortiOS 5.6.1
The following new server load balancing features are available in FortiOS 5.6.1:

Add server load balancing real servers on the Virtual Server GUI page (416709)

In previous versions of the FortiOSGUI, after adding a Virtual Server you would go to Policy & Objects > Real
Servers to add real servers and associate each real server with a virtual server.

In FortiOS 5.6.1 you now go to Policy & Objects > Virtual Servers, configure a virtual server and then from
the same GUI page add real servers to the virtual server. In addition, on the Virtual Server GUI page the option
Outgoing Interface is renamed Interface and the load balancing method Source IP Hash has been renamed
Static.
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What's new for server load balancing in FortiOS 5.6
The following new server load balancing features are available in FortiOS 5.6:

IPv6, 6to4, and 4to6 server load balancing (280073)

Sever load balancing is supported for:
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l IPv6 VIPs (config firewall vip6)
l IPv6 to IPv4 (6to4) VIPs (config firewall vip64)
l IPv4 to IPv6 (4to6) VIPs (config firewall vip46)

Configuration is the same as IPv4 VIPs, except support for advanced HTTP and SSL related features is not
available. IPv6 server load balancing supports all the same server types as IPv4 server load balancing (HTTP,
HTTPS, IMAPS, POP3S, SMTPS, SSL, TCP, UDP, and IP). IPv4 to IPv6 and IPv6 to IPv4 server load balancing
supports fewer server types (HTTP, TCP, UDP, and IP).

Improved Server load balancing GUI pages (404169)

Server load balancing GUI pages have been updated and now include more functionality and input verification.

Inside FortiOS: Server Load Balancing

Server load balancing distributes workloads across multiple network servers, allowing simultaneous IPv4, IPv6,
IPv4 to IPv6 and IPv6 to IPv4 requests to be handled quickly and reliably.

Server Load Balancing combined with NGFW and UTM protection
By introducing comprehensive server load balancing functionality to Next Generation Firewall (NGFW) and
Unified Threat Management (UTM) solutions FortiOS takes threat protection to a whole new level. Rather than
going to the expense of deploying multiple solutions to protect your server farm, you can combine firewalling,
NGFW, UTM and load balancing into a single FortiGate unit or cluster. The benefit of consolidation is not only
limited to cost.

Key Features & Benefits

Increased
resilience

A consolidated solution results in significantly simplified network architecture. High availability can
be provided for all technologies with just a pair of devices rather than several.
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Reduced
operational
overheads

A unified management solution consisting of a single GUI, logging and reporting, SNMPmonitoring
and other management functions will significantly reduce the resources required to manage the
multiple technology areas. A consolidated solution provides a single point of contact for support and
renewals rather than having to deal with multiple vendors.

The FortiOS server load balancing feature set contains all of the features you would expect of a server load
balancing solution. Traffic can be balanced across multiple backend servers based on multiple load balancing
schedules including static (failover), round robin, weighted to account for different sized servers, or based on the
health and performance of the server including round trip time and number of connections.

The load balancer supports HTTP, HTTPS, IMAPS, POP3S, SMTPS, SSL/TLS, and generic TCP/UDP and IP
protocols. Session persistence is supported based on the SSL session ID, based on an injected HTTP cookie, or
based on the HTTP or HTTPS host. SSL/TLS load balancing includes protection from protocol downgrade
attacks. Server load balancing is supported on most FortiGate devices and includes up to 10,000 virtual servers
on our high end systems.

SSL/TLS offloading
With more and more critical business applications being made available online and in the cloud, the demand for
secure remote continues to increase. While securing web and email applications with SSL/TLS is essential, this
protection adds significant performance overheads. An SSL/TLS protected application running on a standard
server will perform all the costly encryption/decryption and key exchange routines in software which uses vital
CPU resources that should be available for running the application. The consequence of this is that many more or
more powerful servers are required to deliver the application.

FortiGate SSL/TLS offloading is designed with the explosion of SSL/TLS applications in mind. The key exchange
and encryption/decryption tasks are offloaded to the FortiGate unit where they are accelerated using FortiASIC
technology providing significantly more performance than a standard server or load balancer could handle. This
frees up valuable resources on the server farm which can be used to run a more responsive business. Server load
balancing offloads most SSL/TLS versions including SSL 3.0, TLS 1.0 and TLS 1.2 and supports full mode or half
mode SSL offloading with DH key sizes up to 4096 bits.

SSL/TLS content inspection
Traditionally, SSL encrypted application data would be invisible to any border gateway filtering solution. This is
because the encryption process prevents the payload of any connection from being seen other than by the
communicating systems. FortiGate SSL Offloading allows the application payload to be inspected before it
reaches your servers; preventing intrusion attempts, blocking viruses, stopping unwanted applications, and
preventing data leakage. SSL/TLS content inspection supports TLS versions 1.0, 1.1, and 1.2 and SSL versions
1.0, 1.1, 1.2, and 3.0.

Health Check
Health checking can be enabled to prevent load balancing traffic from being sent to a non-functioning real server.
Real server health can be monitored using ICMP ping or more sophisticated TCP testing. The most
comprehensive test is HTTPwhich verifies that the HTTP application is responding and that it is returning the
correct content.

Health checking removes real servers from the load balancing cluster which are returning invalid content. The
removal of real servers from the clusters is based on the Interval, Timeout and Retry Settings:
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Interval How often to test the server.

Timeout What maximum response time is permissible before a server is treated as non-functional.

Retry Howmany failures before the server is considered “dead” and removed from the cluster.

Server Monitoring and Management
The health and performance of real servers can be monitored from the FortiGate GUI. Virtual servers and their
assigned real servers can be monitored for health status, if there have been any monitor events, number of active
sessions, round trip time and number of bytes processed. Should a server become problematic and require
administration, it can be gracefully removed from the Real Server pool to enable disruption free maintenance.
When a removed real server is able to operate it can gracefully be added back to the virtual server.

HTTP Multiplexing
A performance saving feature of HTTP/1.1 compliant web servers is the ability to pipeline requests on the same
connection. This allows a single HTTPD process on the server to interleave and server multiple requests. HTTP
multiplexing reduces the number idle sessions, too many of which can exhaust the resources on a server. The
Fortinet solution has the ability to take multiple separate inbound sessions and multiplex them over the same
internal session. This reduces the load on the backend server and increases the overall performance.

Basic load balancing configuration example

This section describes the steps required to configure the load balancing configuration shown below. In this
configuration a FortiGate-51B unit is load balancing HTTP traffic from the Internet to three HTTP servers on the
Internal network. HTTP sessions are accepted at the wan1 interface with destination IP address 172.20.120.121
on TCP port 8080 and forwarded from the internal interface to the web servers. When forwarded the destination
address of the sessions is translated to the IP address of one of the web servers.

The load balancing configuration also includes session persistence using HTTP cookies, round-robin load
balancing, and TCP health monitoring for the real servers. Ping health monitoring consists of the FortiGate unit
using ICMP ping to make sure the web servers can respond to network traffic.
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Virtual server and real servers setup

To configure the example load balancing configuration - general configuration steps

1. Add a load balance ping health check monitor.
A ping health check monitor causes the FortiGate unit to ping the real servers every 10 seconds. If one of the
servers does not respond within 2 seconds, the FortiGate unit will retry the ping 3 times before assuming that the
HTTP server is not responding.

2. Add a load balance virtual server.
3. Add the three load balance real servers to the virtual server.
4. Add a security policy that includes the load balance virtual server as the destination address.

To configure the example load balancing configuration

1. Go to Policy & Objects > Health Check and add the following health check monitor.
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Name Ping-mon-1

Type Ping

Interval 10 seconds

Timeout 2 seconds

Retry 3

2. Go to Policy & Objects > Virtual Servers and add a virtual server that accepts the traffic to be load balanced.

Name Vserver-HTTP-1

Type HTTP

Interface wan1

Virtual Server IP 172.20.120.121

Virtual Server Port 8080

Load Balance Method Round Robin

Persistence HTTPCookie

Health Check Ping-mon-1

HTTP Multiplexing Do not select

Preserve Client IP Do not select

3. On the same GUI page and the real servers to the virtual server.

IP Address 10.31.101.30

Port 80

Max Connections 0

Mode Active

IP Address 10.31.101.40

Port 80

Max Connections 0

Mode Active

IP Address 10.31.101.50

Port 80
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Max Connections 0

Mode Active

4. Go to Policy & Objects > IPv4 Policy and add a wan1 to internal security policy that includes the virtual server.
This policy also applies an Antivirus profile to the load balanced sessions.

Name Example-policy

Incoming Interface wan1

Outgoing Interface internal

Source all

Destination Vserver-HTTP-1

Schedule always

Service ALL

Action ACCEPT

NAT Turn on NAT and select Use Outgoing Interface Address.

Antivirus Turn on and select an Antivirus profile.

5. Select OK.

To configure the example load balancing configuration from the CLI

1. Use the following command to add a Ping health check monitor.
config firewall ldb-monitor

edit ping-mon-l
set type ping
set interval 10
set timeout 2
set retry 3

end

2. Use the following command to add the virtual server that accepts HTTP sessions on port 8080 at the wan1
interface and load balances the traffic to three real servers.
config firewall vip

edit Vserver-HTTP-1
set type server-load-balance
set server-type http
set ldb-method round-robin
set extip 172.20.120.30
set extintf wan1
set extport 8080
set persistence http-cookie
set monitor tcp-mon-1

config realservers
edit 1

set ip 10.31.101.30
set port 80
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next
edit 2

set ip 10.31.101.40
set port 80

end
edit 3

set ip 10.31.101.50
set port 80

end
end

3. Use the following command to add a security policy that includes the load balance virtual server as the destination
address.
config firewall policy

edit 0
set srcintf wan1
set srcaddr all
set dstintf internal
set dstaddr Vserver-HTTP-1
set action accept
set schedule always
set service ALL
set nat enable
set utm-status enable
set profile-protocol-options default
set av-profile scan

end
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Configuring load balancing

This section describes how to use the FortiOS server load balancing to load balance traffic to multiple backend
servers.

You can configure FortiOS load balancing to intercept incoming traffic with a virtual server and distribute it among
one or more backend real servers. By doing so, FortiOS enables multiple real servers to respond as if they were a
single device or virtual server. This in turn means that more simultaneous requests can be handled by the servers.

Traffic can be balanced across multiple backend real servers based on a selection of load balancing methods
including static (failover), round robin, weighted to account for different sized servers, or based on the health and
performance of the server including round trip time, number of connections. The load balancer can balance layer
7 HTTP, HTTPS, SSL, generic layer 4 TCP, UDP and generic layer 3 IP protocols. Session persistence is
supported based on injected HTTP/HTTPS cookies or the SSL session ID.

You can bind up to 8 real servers can to one virtual server. The real server topology is transparent to end users,
and the users interact with the system as if it were only a single server with the IP address and port number of the
virtual server. The real servers may be interconnected by high-speed LAN or by geographically dispersed WAN.
The FortiGate unit schedules requests to the real servers and makes parallel services of the virtual server to
appear to involve a single IP address.

There are additional benefits to load balancing. First, because the load is distributed across multiple servers, the
service being provided can be highly available. If one of the servers breaks down, the load can still be handled by
the other servers. Secondly, this increases scalability. If the load increases substantially, more servers can be
added behind the FortiGate unit to cope with the increased load.
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Server load balancing configuration

Traffic can be balanced across multiple backend real servers based on a selection of load balancing methods
including static (failover), round robin, weighted to account for different sized servers, or based on the health and
performance of the server including round trip time, number of connections. The load balancer can balance layer
7 HTTP, HTTPS, SSL, generic layer 4 TCP, UDP and generic layer 3 IP protocols. Session persistence is
supported based on injected HTTP/HTTPS cookies or the SSL session ID.

You can bind up to 8 real servers can to one virtual server. The real server topology is transparent to end users,
and the users interact with the system as if it were only a single server with the IP address and port number of the
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virtual server. The real servers may be interconnected by high-speed LAN or by geographically dispersed WAN.
The FortiGate unit schedules requests to the real servers and makes parallel services of the virtual server to
appear to involve a single IP address.

Load balancing and other FortiOS features
Flow-based and proxy-based security features such as virus scanning, IPS, DLP, application control, and web
filtering can be applied to load balanced sessions. This includes SSL offloading and multiplexing. Applying these
UTM features to load balancing traffic may reduce load balancing performance.

Authentication is not supported for load balancing sessions. Usually FortiGate load balancing is used to allow
public access to services on servers protected by a FortiGate unit. Authentication is not generally not required for
this kind of configuration.

Features such web proxying, web caching, and WAN optimization also do not work with load balanced sessions.
However, most other features that can be applied by a security policy are supported.

Configuring load balancing from the GUI
A virtual server is a specialized firewall virtual IP that performs server load balancing. From the GUI you add load
balancing virtual server by going to Policy & Objects > Virtual Servers.

You can use the GUI to configure IPv4 server load balancing. To configure IPv6, IPv6 to IPv4, or IPv4 to IPv6 load
balancing you need to use the CLI.

Name

Enter the name for the virtual server.

Type

Select the protocol to be load balanced by the virtual server. If you select a general protocol such as IP, TCP, or
UDP the virtual server load balances all IP, TCP, or UDP sessions. If you select specific protocols such asHTTP,
HTTPS, or SSL you can apply additional server load balancing features such asPersistence and HTTP
Multiplexing.

l Select HTTP to load balance only HTTP sessions with destination port number that matches the Virtual Server
Port setting. Change Virtual Server Port to match the destination port of the sessions to be load balanced
(usually port 80 for HTTP sessions). You can also select HTTP Multiplex. You can also set Persistence to HTTP
Cookie to select cookie-based persistence.

l Select HTTPS to load balance only HTTPS sessions with destination port number that matches the Virtual Server
Port setting. Change Virtual Server Port to match the destination port of the sessions to be load balanced
(usually port 443 for HTTPS sessions). You can also select Multiplex HTTP requests/responses. You can also
set Persistence to HTTP Cookie to select cookie-based persistence. You can also set Persistence to SSL
Session ID.

l Select IMAPS to load balance only IMAPS sessions with destination port number that matches the Virtual Server
Port setting. Change Virtual Server Port to match the destination port of the sessions to be load balanced
(usually port 993 for IMAPS sessions). You can also set Persistence to SSL Session ID.

l Select POP3S to load balance only POP3S sessions with destination port number that matches the Virtual Server
Port setting. Change Virtual Server Port to match the destination port of the sessions to be load balanced
(usually port 995 for POP3S sessions). You can also set Persistence to SSL Session ID.
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l Select SMTPS to load balance only SMTPS sessions with destination port number that matches the Virtual
Server Port setting. Change Virtual Server Port to match the destination port of the sessions to be load
balanced (usually port 465 for SMTPS sessions). You can also set Persistence to SSL Session ID.

l Select SSL to load balance only SSL sessions with destination port number that matches the Virtual Server Port
setting. Change Virtual Server Port to match the destination port of the sessions to be load balanced.

l Select TCP to load balance only TCP sessions with destination port number that matches the Virtual Server Port
setting. Change Virtual Server Port to match the destination port of the sessions to be load balanced.

l Select UDP to load balance only UDP sessions with destination port number that matches the Virtual Server Port
setting. Change Virtual Server Port to match the destination port of the sessions to be load balanced.

l Select IP to load balance all sessions accepted by the security policy that contains this virtual server.

Interface

Select the virtual server external or outgoing interface from the list. The outgoing interface is connected to the
source network and receives the packets to be forwarded to the destination network.

Virtual Server IP

The IPv4 address of the virtual server. This is an IP address on the external interface that you want to map to an
address on the destination network.

Virtual Server Port

Enter the external port number that you want to map to a port number on the destination network. Sessions with
this destination port are load balanced by this virtual server.

Load Balance Method

Select the load balancing method used by the virtual server.

Persistence

Configure persistence to make sure that a user is connected to the same server every time they make a request
that is part of the same session. Session persistence is supported for HTTP and SSL sessions.

Health Check

Select which health check monitor configuration will be used to determine a server’s connectivity status.

HTTP Multiplexing

Select to use the FortiGate unit to multiplex multiple client connections into a few connections between the
FortiGate unit and the real server.

Preserve Client IP

Select to preserve the IP address of the client in the X-Forwarded-For HTTP header. This can be useful if you
want log messages on the real servers to the client’s original IP address. If this option is not selected, the header
will contain the IP address of the FortiGate unit.

This option appears only if Type is set to HTTP or HTTPS.

2972 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 26 - Server Load Balancing Configuring load balancing

SSL Offloading

Accelerate clients’ SSL connections to the server by using the FortiGate to perform SSL operations. This option
appears only if Type is set to one of the SSL protocols.

Mode

Select which segments of the SSL connection will receive SSL offloading. You can select Client <-> FortiGate
(or half mode) or Full (full mode).

This option appears only if Type is set to one of the SSL protocols.

Certificate

Select the certificate to use with SSL Offloading. The certificate key size must be 1024 or 2048 bits. 4096-bit
keys are not supported.

This option appears only if Type is set to one of the SSL protocols.

Real Servers

Add Real Servers to the virtual server. The virtual server load balances traffic to these real servers. See Real
servers on page 2975.

Configuring load balancing from the CLI
From the CLI you configure IPv4 load balancing by adding a firewall virtual IP and setting the virtual IP type to
server load balance:

config firewall vip
edit Vserver-HTTP-1

set type server-load-balance
...

Sever load balancing is also supported for:

l IPv6 using the command config firewall vip6

l IPv6 to IPv4 using the command config firewall vip64

l IPv4 to IPv6 using the commmand config firewall vip46

Configuration is the same as IPv4 VIPs except support for advanced HTTP and SSL related features is not
available. IPv6 server load balancing supports all the same server types as IPv4 server load balancing (HTTP,
HTTPS, IMAPS, POP3S, SMTPS, SSL, TCP, UDP, and IP). IPv4 to IPv6 and IPv6 to IPv4 server load balancing
supports fewer server types (HTTP, TCP, UDP, and IP).

A virtual server includes a virtual server IP address bound to an interface. The virtual server IP address is the
destination address incoming packets to be load balanced and the virtual server is bound to the interface that
receives the packets to be load balanced.

For example, if you want to load balance incoming HTTP traffic from the Internet to a group of web servers on a
DMZ network, the virtual server IP address is the known Internet IP address of the web servers and the virtual
server binds this IP address to the FortiGate interface connected to the Internet.

When you bind the virtual server’s external IP address to a FortiGate unit interface, by default, the network
interface responds to ARP requests for the bound IP address. Virtual servers use proxy ARP, as defined in RFC
1027, so that the FortiGate unit can respond to ARP requests on a network for a real server that is actually
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installed on another network. In some cases you may not want the network interface sending ARP replies. You
can use the arp-reply option disable sending ARP replies:

config firewall vip
edit Vserver-HTTP-1

set type server-load-balance
set arp-reply disable
...

The load balancing virtual server configuration also includes the virtual server port. This is the TCP port on the
bound interface that the virtual server listens for traffic to be load balanced on. The virtual server can listen on any
port.

Load balancing methods
The load balancing method defines how sessions are load balanced to real servers. A number of load balancing
methods are available as listed below.

All load balancing methods will not send traffic to real servers that are down or not responding. However, the
FortiGate unit can only determine if a real server is not responding by using a health check monitor. You should
always add at least one health check monitor to a virtual server or to individual real servers, or load balancing
methods may attempt to distribute sessions to real servers that are not functioning.

Static

The traffic load is statically spread evenly across all real servers. However, sessions are not assigned according to
how busy individual real servers are. This load balancing method provides some persistence because all sessions
from the same source address always go to the same real server. However, the distribution is stateless, so if a
real server is added or removed (or goes up or down) the distribution is changed and persistence could be lost.

Round Robin

Directs new requests to the next real server, and treats all real servers as equals regardless of response time or
number of connections. Dead real servers or non responsive real servers are avoided.

Weighted

Real servers with a higher weight value receive a larger percentage of connections. Set the real server weight
when adding a real server.

Least Session

Directs requests to the real server that has the least number of current connections. This method works best in
environments where the real servers or other equipment you are load balancing all have similar capabilities. This
load balancing method uses the FortiGate session table to track the number of sessions being processed by each
real server. The FortiGate unit cannot detect the number of sessions actually being processed by a real server.

Least RTT

Directs sessions to the real server with the least round trip time. The round trip time is determined by a Ping
health check monitor and is defaulted to 0 if no Ping health check monitors are added to the virtual server.
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First Alive

Always directs sessions to the first alive real server. This load balancing schedule provides real server failover
protection by sending all sessions to the first alive real server and if that real server fails, sending all sessions to
the next alive real server. Sessions are not distributed to all real servers so all sessions are processed by the “first”
real server only.

First refers to the order of the real servers in the virtual server configuration. For example, if you add real servers
A, B and C in that order, then all sessions always go to A as long as it is alive. If A goes down then sessions go to
B and if B goes down sessions go to C. If A comes back up sessions go back to A. Real servers are ordered in the
virtual server configuration in the order in which you add them, with the most recently added real server last. If
you want to change the order you must delete and re-add real servers in the required order.

HTTP Host

Load balances HTTP host connections across multiple real servers using the host’s HTTP header to guide the
connection to the correct real server.

Session persistence
Use persistence to make sure that a user is connected to the same real server every time they make an HTTP,
HTTPS, or SSL request that is part of the same user session. For example, if you are load balancing HTTP and
HTTPS sessions to a collection of eCommerce web servers, when a user is making a purchase they will be
starting multiple sessions as they navigate the eCommerce site. In most cases all of the sessions started by this
user during on eCommerce session should be processed by the same real server. Typically, the HTTP protocol
keeps track of these related sessions using cookies. HTTP cookie persistence makes sure that all sessions that
are part of the same user session are processed by the same real server

When you configure persistence, the FortiGate unit load balances a new session to a real server according to the
load balance method. If the session has an HTTP cookie or an SSL session ID, the FortiGate unit sends all
subsequent sessions with the same HTTP cookie or SSL session ID to the same real server. For more information
about HTTP and HTTPS persistence, see “HTTP and HTTPS persistence”.

Real servers
Add real servers to a load balancing virtual server to provide the information the virtual server requires to be able
to send sessions to the server. A real server configuration includes the IP address of the real server and port
number that the real server receives sessions on. The FortiGate unit sends sessions to the real server’s IP
address using the destination port number in the real server configuration.

When configuring a real server you can also specify the weight (used if the load balance method is set to
weighted) and you can limit the maximum number of open connections between the FortiGate unit and the real
server. If the maximum number of connections is reached for the real server, the FortiGate unit will automatically
switch all further connection requests other real servers until the connection number drops below the specified
limit. Setting Maximum Connections to 0 means that the FortiGate unit does not limit the number of connections
to the real server.

Real server active, standby, and disabled modes

By default the real server mode setting is active indicating that the real server is available to receive connections.
If the real server is removed from the network (for example, for routine maintenance or because of a hardware or
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software failure) you can change the mode to standby or disabled. In disabled mode the FortiGate unit no longer
sends sessions to the real server.

If a real server is in standby mode the FortiGate also does not send sessions to it unless other real servers added
to the same virtual server become unavailable. For example:

l A virtual server that includes two real servers one in active mode and one in standby mode. If the real server in
active mode fails, the real server in standby mode is changed to active mode and all sessions are sent to this real
server.

l A virtual server includes three real servers, two in active mode and one in standby mode, if one of the real servers in
active mode fails, the real server in standby mode is changed to active mode and sessions are load balanced
between it and still operating real server. If both real servers in active mode fail, all sessions are sent to the real
server in standby mode.

Adding real servers from the GUI

To add a real server from the GUI go to Policy & Objects > Virtual Servers, edit a virtual server and under
Real Servers select Create New to add a real server to this virtual server.

IP Address

Enter the IP address of the real server.

Port

Enter the port number on the destination network to which the external port number is mapped.

Weight

Enter the weight value of the real server. The higher the weight value, the higher the percentage of connections
the server will handle. A range of 1-255 can be used. This option is available only if the associated virtual server’s
load balance method isWeighted.

Max Connections

Enter the limit on the number of active connections directed to a real server. A range of 1-99999 can be used. If
the maximum number of connections is reached for the real server, the FortiGate unit will automatically switch all
further connection requests to another server until the connection number drops below the specified limit.

SettingMaximum Connections to 0means that the FortiGate unit does not limit the number of connections to
the real server.

HTTP Host

Enter the HTTP header for load balancing across multiple real servers. This feature is used for load balancing
HTTP host connections across multiple real servers using the host’s HTTP header to guide the connection to the
correct real server, providing better load balancing for those specific connections.

Mode

Select a mode for the real server. The real server can be active, on standby, or disabled.
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Adding real servers from the CLI

To add a real server from the CLI you configure a virtual server and add real servers to it. For example, to add
three real servers to a virtual server that load balances UDP sessions on port 8190 using weighted load balancing.
For each real server the port is not changed. The default real server port is 0 resulting in the traffic being sent the
real server with destination port 8190. Each real sever is given a different weight. Servers with higher weights
have a max-connections limit to prevent too many sessions from being sent to them.

config firewall vip
edit Vserver-UDP-1

set type server-load-balance
set server-type udp
set ldb-method weighted
set extip 172.20.120.30
set extintf wan1
set extport 8190
set monitor ping-mon-1

config realservers
edit 1

set ip 10.31.101.30
set weight 100
set max-connections 10000

next
edit 2

set ip 10.31.101.40
set weight 100
set max-connections 10000

next
edit 3

set ip 10.31.101.50
set weight 10

end
end

Health check monitoring
From the FortiGate GUI you can go to Policy & Objects > Health Check and configure health check
monitoring so that the FortiGate unit can verify that real servers are able respond to network connection
attempts. If a real server responds to connection attempts the load balancer continues to send sessions to it. If a
real server stops responding to connection attempts the load balancer assumes that the server is down and does
not send sessions to it. The health check monitor configuration determines how the load balancer tests the real
servers. You can use a single health check monitor for multiple load balancing configurations.

You can configure TCP, HTTP and Ping health check monitors. Usually you would want the health check monitor
to use the same protocol for checking the health of the server as the traffic being load balanced to it. For
example, for an HTTP load balancing configuration you would normally use an HTTP health check monitor.

For the TCP and HTTP health check monitors you can specify the destination port to use to connect to the real
servers. If you set the port to 0, the health check monitor uses the port defined in the real server. This allows you
to use the same health check monitor for multiple real servers using different ports. You can also configure the
interval, timeout and retry. A health check occurs every number of seconds indicated by the interval. If a reply is
not received within the timeout period the health check is repeated every second. If no response is received after
the number of configured retires, the virtual server is considered unresponsive, and load balancing does not srend
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traffic to that real server. The health check monitor will continue to contact the real server and if successful, the
load balancer can resume sending sessions to the recovered real server.

The default health check configuration has an interval of 10 seconds, a timeout of 2 seconds and a retry of 3. This
means that the health check monitor checks the health of a real server every 10 seconds. If a reply is not received
within 2 seconds the health check monitor re-checks the server every second for 3 retries. If no response is
received for 2 seconds after the final retry the server is considered unresponsive. This entire process takes a total
of 7 seconds to consider a virtual server as unresponsive (2 second timeout + (3 re-checks x 1 second) + 2 second
timeout = 7 seconds). Since this health check process is repeated every 10 seconds, a server can be down for a
maximum of 10 + 7 = 17 seconds before the health check monitor considers it down.

For HTTP health check monitors, you can add URL that the FortiGate unit connects to when sending a get
request to check the health of a HTTP server. The URL should match an actual URL for the real HTTP servers.
The URL is optional.

The URL would not usually include an IP address or domain name. Instead it should start with a “/” and be
followed by the address of an actual web page on the real server. For example, if the IP address of the real server
is 10.31.101.30, the URL “/test_page.htm” causes the FortiGate unit to send an HTTP get request to
“http://10.31.101.30/test_page.htm”.

For HTTP health check monitors, you can also add a matched content phrase that a real HTTP server should
include in response to the get request sent by the FortiGate unit using the content of the URL option. If the URL
returns a web page, the matched content should exactly match some of the text on the web page. You can use
the URL and Matched Content options to verify that an HTTP server is actually operating correctly by responding
to get requests with expected web pages. Matched content is only required if you add a URL.

For example, you can set matched content to “server test page” if the real HTTP server page defined by the URL
option contains the phrase “server test page”. When the FortiGate unit receives the web page in response to the
URL get request, the system searches the content of the web page for the matched content phrase.

Name

Enter the name of the health check monitor configuration.

Type

Select the protocol used to perform the health check.

l TCP
l HTTP
l PING

Port

Enter the port number used to perform the health check. If you set the Port to 0, the health check monitor uses
the port defined in the real server. This way you can use a single health check monitor for different real servers.

This option does not appear if the Type is PING.

Interval

Enter the number of seconds between each server health check.
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URL

For HTTP health check monitors, add a URL that the FortiGate unit uses when sending a get request to check the
health of a HTTP server. The URL should match an actual URL for the real HTTP servers. The URL is optional.

The URL would not usually include an IP address or domain name. Instead it should start with a “/” and be
followed by the address of an actual web page on the real server. For example, if the IP address of the real server
is 10.10.10.1, the URL “/test_page.htm” causes the FortiGate unit to send an HTTP get request to
“http://10.10.10.1/test_page.htm”.

This option appears only if Type isHTTP.

Matched Content

For HTTP health check monitors, add a phrase that a real HTTP server should include in response to the get
request sent by the FortiGate unit using the content of the URL option. If the URL returns a web page, the
Matched Content should exactly match some of the text on the web page. You can use the URL andMatched
Content options to verify that an HTTP server is actually operating correctly by responding to get requests with
expected web pages. Matched content is only required if you add a URL.

For example, you can set Matched Content to “server test page” if the real HTTP server page defined by the
URL option contains the phrase “server test page”. When the FortiGate unit receives the web page in response to
the URL get request, the system searches the content of the web page for theMatched Content phrase.

This option appears only if Type isHTTP.

Max Redirects

For an HTTP health check monitor, specify the maximum number of redirects that the health check monitor will
follow when testing the health of the real HTTP server. This feature allows you to do health checking of the HTTP
server is accessed through one or more redirects.

Timeout

Enter the number of seconds which must pass after the server health check to indicate a failed health check.

Retry

Enter the number of times, if any, a failed health check will be retried before the server is determined to be
inaccessible.

Load balancing limitations
The following limitations apply when adding virtual IPs, load balancing virtual servers, and load balancing real
servers. Load balancing virtual servers are actually server load balancing virtual IPs. You can add server load
balance virtual IPs from the CLI.

l Virtual IPExternal IP Address/Range entries or ranges cannot overlap with each other or with load balancing
virtual server Virtual Server IP entries.

l A virtual IPMapped IP Address/Range cannot be 0.0.0.0 or 255.255.255.255.
l A real server IP cannot be 0.0.0.0 or 255.255.255.255.
l If a static NAT virtual IPExternal IP Address/Range is 0.0.0.0, theMapped IP Address/Rangemust be a

single IP address.
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l If a load balance virtual IPExternal IP Address/Range is 0.0.0.0, theMapped IP Address/Range can be an
address range.

l When port forwarding, the count of mapped port numbers and external port numbers must be the same. The GUI
does this automatically but the CLI does not.

l Virtual IP and virtual server names must be different from firewall address or address group names.

Monitoring load balancing
From the GUI you can go toMonitor > Load Balance Monitor to monitor the status of configured virtual
servers and real servers and start or stop the real servers. You can also use the get test ipldb command
from the CLI to display similar information.

For each real server the monitor displays health status (up or down), active sessions, round trip time (RTT) and
the amount of bytes of data processed. From the monitor page you can also stop sending new sessions to any
real server. When you select to stop sending sessions the FortiGate unit performs of graceful stop by continuing
to send data for sessions that were established or persistent before you selected stop. However, no new sessions
are started.

Virtual Server

The IP addresses of the existing virtual servers.

Real Server

The IP addresses of the existing real servers.

Health Status

Displays the health status according to the health check results for each real server. A green arrow means the
server is up. A red arrow means the server is down.

Mode

The mode of the health check monitor. Can be active, standby, or disabled.

Monitor Events

Display each real server’s up and down times.

Active Sessions

Display each real server’s active sessions.

RTT (ms)

Displays the Round Trip Time (RTT) of each real server. By default, the RTT is “<1”. This value will change only
when ping monitoring is enabled on a real server.

Bytes Processed

Displays the traffic processed by each real server.
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Graceful Stop/Start

Select to start or stop real servers. When stopping a server, the FortiGate unit will not accept new sessions but
will wait for the active sessions to finish.

Load balancing diagnose commands
You can also use the following diagnose commands to view status information for load balancing virtual servers
and real servers:

diagnose firewall vip realserver {down | flush | healthcheck | list | up}
diagnose firewall vip virtual-server {filter | log | real-server | session | stats}

For example, the following command lists and displays status information for all real servers:

diagnose firewall vip virtual-server real-server

vd root/0 vs vs/2 addr 10.31.101.30:80 status 1/1
conn: max 0 active 0 attempts 0 success 0 drop 0 fail 0

vd root/0 vs vs/2 addr 10.31.101.20:80 status 1/1
conn: max 0 active 0 attempts 0 success 0 drop 0 fail 0

Many of the diagnostic commands involve retrieving information about one or more virtual servers. To control
which servers are queried you can define a filter:

diagnose firewall vip virtual-server filter <filter_str>

Where <filter_str> can be:

l clear erase the current filter
l dst the destination address range to filter by
l dst-port the destination port range to filter by
l list display the current filter
l name the vip name to filter by
l negate negate the specified filter parameter
l src the source address range to filter by
l src-port the source port range to filter by
l vd index of virtual domain. -1 matches all

The default filter is empty so no filtering is done.

Logging Diagnostics

The logging diagnostics provide information about two separate features:

diagnose firewall vip virtual-server log {console | filter}

Where

l console {disable | enable} enables or disables displaying the event log messages generated by virtual
server traffic on the console to simplify debugging.

l filter sets a filter for the virtual server debug log
l The filter option controls what entries the virtual server daemon will log to the console if diagnose debug
application vs level is non-zero. The filtering can be done on source, destination, virtual-server name, virtual
domain, and so on:

diagnose firewall vip virtual-server log filter <filter_str>
Where <filter_str> can be
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l clear erase the current filter
l dst the destination address range to filter by
l dst-port the destination port range to filter by
l list display the current filter
l name the virtual-server name to filter by
l negate negate the specified filter parameter
l src the source address range to filter by
l src-port the source port range to filter by
l vd index of virtual domain. -1 matches all

The default filter is empty so no filtering is done.

Real server diagnostics

Enter the following command to list all the real servers:

diag firewall vip virtual-server real-server list

In the following example there is only one virtual server called slb and it has two real-servers:

diag firewall vip virtual-server server
vd root/0 vs slb/2 addr 172.16.67.191:80 status 1/1
conn: max 10 active 0 attempts 0 success 0 drop 0 fail 0
http: available 0 total 0

vd root/0 vs slb/2 addr 172.16.67.192:80 status 1/1
conn: max 10 active 1 attempts 4 success 4 drop 0 fail 0
http: available 1 total 1

The status indicates the administrative and operational status of the real-server.

l max indicates that the real-server will only allow 10 concurrent connections.
l active is the number of current connections to the server attempts is the total number of connections attempted

success is the total number of connections that were successful.
l drop is the total number of connections that were dropped because the active count hit max.
l fail is the total number of connections that failed to complete due to some internal problem (for example, lack of

memory).

If the virtual server has HTTPmultiplexing enabled then the HTTP section indicates how many established
connections to the real-sever are available to service a HTTP request and also the total number of connections.

HTTP and HTTPS load balancing, multiplexing, and persistence

In a firewall load balancing virtual server configuration, you can select HTTP to load balance only HTTP sessions.
The virtual server will load balance HTTP sessions received at the virtual server interface with destination IP
address that matches the configured virtual server IP and destination port number that matches the configured
virtual server port. The default virtual server port for HTTP load balancing is 80, but you can change this to any
port number. Similarly for HTTPS load balancing, set the virtual server type to HTTPS and then select the
interface, virtual server IP, and virtual server port that matches the HTTPS traffic to be load balanced. Usually
HTTPS traffic uses port 443.

You can also configure load balancing to offload SSL processing for HTTPS and SSL traffic. See SSL/TLS load
balancing on page 2987.
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HTTP and HTTPS multiplexing
For both HTTP and HTTPS load balancing you can multiplex HTTP requests and responses over a single TCP
connection. HTTPmultiplexing is a performance saving feature of HTTP/1.1 compliant web servers that provides
the ability to pipeline many unrelated HTTP or HTTPS requests on the same connection. This allows a single
HTTPD process on the server to interleave and serve multiple requests. The result is fewer idle sessions on the
web server so server resources are used more efficiently. HTTPmultiplexing can take multiple separate inbound
sessions and multiplex them over the same internal session. This may reduce the load on the backend server and
increase the overall performance.

HTTPmultiplexing may improve performance in some cases. For example, if users web browsers are only
compatible with HTTP 1.0. HTTPmultiplexing can also improve performance between a web server and the
FortiGate unit if the FortiGate unit is performing SSL acceleration. However, in most cases HTTPmultiplexing
should only be used if enabling it leads to a measurable improvement in performance.

To enable HTTPmultiplexing from the GUI, select multiplex HTTP requests/responses over a single TCP
connection. To enable HTTPmultiplexing from the CLI enable the http-multiplex option.

Preserving the client IP address

Select preserve client IP from the GUI or enable the http-ip-header option from the CLI to preserve the IP
address of the client in the X-Forwarded-For HTTP header. This can be useful in an HTTPmultiplexing
configuration if you want to be able to see the original client IP address in log messages on the destination web
server. If this option is not selected, the X-Forwarded-For HTTP header contains the IP address of the
FortiGate unit.

Preserving the client IP address in a different HTTP header

If you select preserve client IP from the GUI or enable the http-ip-header option from the CLI you can also
preserve the client IP in a different HTTP header. This can be useful if you want to use a custom header name
instead of X-Forwarded-For.

You can add the custom header name from the CLI. When http-ip-header is enabled you can add a custom
header name to the http-ip-header-name option. If you don’t add a name the X-Forwarded-For header
is used.

HTTP and HTTPS persistence
Configure load balancing persistence for HTTP or HTTPS to make sure that a user is connected to the same
server every time they make a request that is part of the same session. HTTP cookie persistence uses injected
cookies to enable persistence.

When you configure persistence, the FortiGate unit load balances a new session to a real server according to the
Load Balance Method. If the session has an HTTP cookie or an SSL session ID, the FortiGate unit sends all
subsequent sessions with the same HTTP cookie or SSL session ID to the same real server.

The following example shows how to enable cookie persistence and set the cookie domain to .example.org.

config firewall vip
edit HTTP_Load_Balance

set type server-load-balance
set server-type http
set extport 8080
set extintf port2
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set extip 192.168.20.20
set persistence http-cookie
set http-cookie-domain .example.org

config realservers
edit 1

set ip 10.10.10.1
set port 80

next
edit 2

set ip 10.10.10.2
set port 80

next
edit 3

set ip 10.10.10.3
set port 80

end

How HTTP cookie persistence options work

The following options are available for the config firewall vip command when type is set to server-
load-balance, server-type is set to http or https and persistence is set to http-cookie:

http-cookie-domain-from-host
http-cookie-domain
http-cookie-path
http-cookie-generation
http-cookie-age
http-cookie-share
https-cookie-share

When HTTP cookie persistence is enabled the FortiGate unit inserts a header of the following form into each
HTTP response unless the corresponding HTTP request already contains a FGTServer cookie:

Set-Cookie: FGTServer=E7D01637C4B08E89A6714213A9D85D9C7E4D8158; Version=1; Max-Age=3600

The value of the FGTServer cookie encodes the server that traffic should be directed to. The value is encoded
so as to not leak information about the internal network.

Enable http-cookie-domain-from-host to extract the cookie domain from the host: header in the
HTTP request. For example, to restrict the cookie to.server.com, enter:

The generated cookies could have the following form if the Host: header contains exhost.com:

Set-Cookie: FGTServer=E7D01637C4B08E89A6714213A9D85D9C7E4D8158; Version=1;
Domain=.exhost.com; Max-Age=3600

For more information, see “HTTP host-based load balancing”.

Use http-cookie-domain to restrict the domain that the cookie should apply to. For example, to restrict the
cookie to.server.com, enter:

set http-cookie-domain .server.com

Now all generated cookies will have the following form:

Set-Cookie: FGTServer=E7D01637C4B08E89A6714213A9D85D9C7E4D8158; Version=1;
Domain=.server.com; Max-Age=3600

Use http-cookie-path to limit the cookies to a particular path. For example, to limit cookies to the path
/sales, enter:

set http-cookie-path /sales

Now all generated cookies will have the following form:
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Set-Cookie: FGTServer=E7D01637C4B08E89A6714213A9D85D9C7E4D8158; Version=1;
Domain=.server.com; Path=/sales; Max-Age=3600

Use http-cookie-age to change how long the browser caches the cookie. You can enter an age in minutes or
set the age to 0 to make the browser keep the cookie indefinitely:

set http-cookie-age 0

Now all generated cookies will have the following form:

Set-Cookie: FGTServer=E7D01637C4B08E89A6714213A9D85D9C7E4D8158; Version=1;
Domain=.server.com; Path=/sales

Use http-cookie-generation to invalidate all cookies that have already been generated. The exact value
of the generation is not important, only that it is different from any generation that has already been used for
cookies in this domain. The simplest approach is to increment the generation by one each time invalidation is
required. Since the default is 0, enter the following to invalidate all existing cookies:

set http-cookie-generation 1

Use http-cookie-share {disable | same-ip} to control the sharing of cookies across virtual servers
in the same virtual domain. The default setting same-ip means that any FGTServer cookie generated by one
virtual server can be used by another virtual server in the same virtual domain. For example, if you have an
application that starts on HTTP and then changes to HTTPS and you want to make sure that the same server is
used for the HTTP and HTTPS traffic then you can create two virtual servers, one for port 80 (for HTTP) and one
for port 443 (for HTTPS). As long as you add the same real servers to both of these virtual servers (and as long as
both virtual servers have the same number of real servers with the same IP addresses), then cookies generated
by accessing the HTTP server are reused when the application changes to the HTTPS server.

If for any reason you do not want this sharing to occur then select disable to make sure that a cookie generated
for a virtual server cannot be used by other virtual servers.

Use https-cookie-secure to enable or disable using secure cookies. Secure cookies are disabled by default
because secure cookies can interfere with cookie sharing across HTTP and HTTPS virtual servers. If enabled,
then the Secure tag is added to the cookie inserted by the FortiGate unit:

Set-Cookie: FGTServer=E7D01637C4B08E89A6714213A9D85D9C7E4D8158; Version=1; Max-Age=3600;
Secure

HTTP host-based load balancing
When configuring HTTP or HTTPS load balancing you can select HTTP host load balancing to load balance
HTTP host connections across multiple real servers using the host’s HTTP header to guide the connection to the
correct real server. HTTP 1.1 includes the concept of a virtual server which allows a HTTP or HTTPS server with a
single external IP address to serve requests for multiple DNS domains by using the mandatory Host: header in a
HTTP request to indicate which DNS domain the request is destined for.

FortiOS can load-balance HTTP and HTTPS connections among multiple real servers using the Host: header to
guide the connection to the correct real server. The host load balancing method allows a real server to specify a
http-host attribute which is the domain name of the traffic for that real server. Each real server can only
specify a single domain name. The same domain name can appear in more than one real server but only the first
one that is up will be used, any others are purely for redundancy. If the Host: header contains a domain that does
not match any http-host entry then the connection will be dropped. A real server with no http-host can be matched
by any Host: domain.

For example, consider a FortiGate unit that is load-balancing traffic to three real servers. Traffic for
www.example1.com should go to 192.168.2.1, traffic for www.example2.com should go to 192.168.2.2 and
traffic to any other domain should go to 192.168.2.3. To enable this configuration you would add a virtual server
and set the load balance method to HTTP host. Then you would add three real servers and set the HTTP host of
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the real server with IP address 192.168.2.1 to www.example1.com, the HTTP host of the real server with IP
address 192.168.2.2 to www.example2.com and you would not specify an HTTP host for the third real server.

The configuration of a virtual IP to achieve this result would be:

config firewall vip
edit "http-host-ldb"

set type server-load-balance
set extip 172.16.67.195
set extintf "lan"
set server-type http
set ldb-method http-host
set extport 80

config realservers
edit 1

set http-host "www.example1.com"
set ip 192.168.2.1
set port 80

next
edit 2

set http-host "www.example2.com"
set ip 192.168.2.2
set port 80

next
edit 3

set ip 192.168.2.3
set port 80

next
end

end

Host load balancing and HTTP cookie persistence

In an HTTP host-based load balancing configuration with HTTP cookie persistence enabled you can optionally
configure cookie persistence to use the domain set in the host header as the cookie domain. You can do this by
enabling the http-cookie-domain-from-host option, for example:

config firewall vip
edit "http-host-ldb"

set type server-load-balance
set extip 172.16.67.195
set extintf "lan"
set server-type http
set ldb-method http-host
set extport 80
set persistence http-cookie
set http-cookie-domain-from-host enable

config realservers
edit 1

set http-host "www.example1.com"
set ip 192.168.2.1
set port 80

next
edit 2

set http-host "www.example2.com"
set ip 192.168.2.2
set port 80

next
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edit 3
set ip 192.168.2.3
set port 80

next
end

end

SSL/TLS load balancing

In a firewall load balancing virtual server configuration, you can select SSL to load balance only SSL and TLS
sessions. The virtual server will load balance SSL and TLS sessions received at the virtual server interface with
destination IP address that matches the configured virtual server IP and destination port number that matches
the configured virtual server port. Change this port to match the destination port of the sessions to be load
balanced.

For SSL load balancing you can also set persistence to SSL session ID. Persistence is achieved by the FortiGate
unit sending all sessions with the same SSL session ID to the same real server. When you configure persistence,
the FortiGate unit load balances a new session to a real server according to the Load Balance Method. If the
session has an SSL session ID, the FortiGate unit sends all subsequent sessions with the same SSL session ID to
the same real server.

SSL/TLS offloading
Use SSL offloading to accelerate clients’ SSL or HTTPS connections to real servers by using the FortiGate unit to
perform SSL/TLS operations (offloading them from the real servers using the FortiGate unit’s SSL acceleration
hardware). FortiGate units can offload most versions of SSL/TLS, including SSL 3.0, TLS 1.0 and TLS 1.2.
SSL/TLS offloading is available on FortiGate units that support SSL acceleration.

To configure SSL offloading from the GUI go to Policy & Objects > Virtual Servers. Add a virtual server and
set the type to HTTPS or SSL and select the SSL offloading type (Client <-> FortiGate orClient <-> FortiGate
<-> Server).

Select Client <-> FortiGate to apply hardware accelerated SSL/TLS processing only to the part of the
connection between the client and the FortiGate unit. This mode is called half mode SSL offloading. The
segment between the FortiGate unit and the server will use clear text communications. This results in best
performance, but cannot be used in failover configurations where the failover path does not have an SSL
accelerator.

Select Client <-> FortiGate <->Server to apply hardware accelerated SSL processing to both parts of the
connection: the segment between client and the FortiGate unit, and the segment between the FortiGate unit and
the server. This mode is called full mode SSL offloading. The segment between the FortiGate unit and the server
will use encrypted communications, but the handshakes will be abbreviated. This is not as efficient as half mode
SSL offloading, but still improves performance. As well full-mode SSL offloading can be used in failover
configurations where the failover path does not have an SSL accelerator. If the server is already configured to use
SSL, this also enables SSL acceleration without requiring changes to the server’s configuration.
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SSL Offloading modes (Half Mode and Full Mode)

Configuring SSL offloading also requires selecting a certificate to use for the SSL offloading sessions. SSL
offloading supports key sizes up to 4096. FortiGate models with CP9 processors support 3072 and 4096 DH bit
sizes in hardware. All FortiGate models up to and including those with CP8 processors only support offloading DH
bit sizes up to 2048 so any sizes larger than that are done in software and thus are relatively resource intensive

The following CLI command shows an example half mode HTTPS SSL offloading configuration. In the example
the ssl-mode option sets the SSL offload mode to half (which is the default mode).

config firewall vip
edit Vserver-ssl-offload

set type server-load-balance
set server-type https
set ldb-method round-robin
set extip 172.20.120.30
set extintf wan1
set extport 443
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set persistence ssl-session-id
set ssl-mode half
set ssl-certificate my-cert
set monitor tcp-mon-1

config realservers
edit 1

set ip 10.31.101.30
set port 443

next
edit 2

set ip 10.31.101.40
set port 443

end
end

Separate virtual-server client and server TLS version and cipher configuration
In previous versions of FortiOS you can configure minimum and maximum SSL/TLS versions that a virtual server
will accept. Those versions primarily applied to the client to FortiGate connection; but, they are also applied to
the FortiGate to server connection. In some cases you may want the to use different versions of SSL or TLS on
the client to FortiGate connection than on the FortiGate to server connection. For example, you may want to use
the FortiGate to protect a legacy SSL 3.0 or TLS 1.0 server while making sure that client to FortiGate connections
must always use the higher level of protection offered by TLS 1.1 or greater.

Similarly in previous versions of FortiOS you could control the cypher suites that can be used by the FortiGate to
negotiate with the client and with the server. But you could only configure the same configuration for both client
and server connections. Also, in some cases you might want to protect a server that only has weak ciphers (for
example, DES or RC4) while making sure that all connections between the FortiGate and the client use a strong
cipher for better protection.

The following new options are available when configuring server load balancing for HTTPS sessions configured
with the following command:

config firewall vip
edit server-name

set type server-load-balance
set server-type https
set ssl-mode full
...

Setting the SSL/TLS versions to use for server and client connections
The ssl-server-min-version, ssl-server-max-version, ssl-min-version and ssl-max-
version configuration options allow the minimum and maximum SSL/TLS versions for the client to FortiGate
connection to be independent of the FortiGate to server configuration. By default these options are both set to
client and the configured ssl-min-version and ssl-max-version settings are applied to both the
client and the server connection.

You can change the ssl-server-min-version and ssl-server-max-version to apply different
options to the server connection. The ssl-min-version and ssl-max-version settings are still applied to
the client connection. If you set the ssl-server-min-version and ssl-server-max-version to an
explicit version then both must be set to an explicit version.
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The ssl-server-min-version and ssl-server-max-version options allow you to specify the
minimum and maximum SSL/TLS versions the FortiGate will offer to the server (in the record header of the
ClientHello) when performing full mode SSL offloading and thus the minimum and maximum SSL/TLS versions
the FortiGate accepts from the server (in a ServerHello). If the server responds with a version in its ServerHello
that is lower than ssl-server-min-version or higher than the ssl-server-max-version then the
FortiGate terminates the connection.

Command syntax is:

config firewall vip
edit server-name

set type server-load-balance
set server-type https
set ssl-mode full
set ssl-min-version {ssl-3.0 | tls-1.0 | tls-1.1 | tls-1.2}
set ssl-max-version {ssl-3.0 | tls-1.0 | tls-1.1 | tls-1.2}
set ssl-server-min-version {ssl-3.0 | tls-1.0 | tls-1.1 | tls-1.2 | client}
set ssl-server-max-version {ssl-3.0 | tls-1.0 | tls-1.1 | tls-1.2 | client}

Setting the SSL/TLS cipher choices for server and client connections
The ssl-algorithm and ssl-server-algorithm configuration options allow the cipher choice for the
FortiGate to server connection to be independent of the client to FortiGate connection. By default, ssl-
server-algorithm is set to client and the configured ssl-algorithm setting is applied to both the
client and the server connection.

You can change the ssl-server-algorithm to apply different options to the server connection. The ssl-
algorithm setting is still applied to the client connection.

The following ssl-server-algorithm options are available:

l high, offer AES or 3DES cypher suites in the ServerHello
l medium, use AES, 3DES, or RC4 cypher suites in the ServerHello
l low, use AES, 3DES, RC4, or DES cypher suites in the ServerHello
l custom, specifiy custom cypher suites using the config ssl-server-cipher-suites and offer these

custom cypher suites in the ServerHello.
l client, offer the cypher suites in the ServerHello that are offered in the ClientHello.

Command syntax is:

config firewall vip
edit server-name

set type server-load-balance
set server-type https
set ssl-mode full
set ssl-algorithm {high | medium | low | custom}
set ssl-server-algorithm {high | medium | low | custom | client}

If you set ssl-server-algorithm to custom, the syntax is:

config firewall vip
edit server-name

set type server-load-balance
set server-type https
set ssl-mode full
set ssl-server-algorithm custom

config ssl-server-cipher-suites
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edit 10
set cipher <cipher-suite>
set versions {ssl-3.0 | tls-1.0 | tls-1.1 | tls-1.2}

next
edit 20

set cipher <cipher-suite>
set versions {ssl-3.0 | tls-1.0 | tls-1.1 | tls-1.2}

end

Protection from TLS protocol downgrade attacks
The ssl-client-fallback option, when enabled (the default configuration), performs downgrade attack
prevention (RFC 7507).

Command syntax is:

config firewall vip
edit server-name

set type server-load-balance
set server-type https
set ssl-client-fallback {disable | enable}

Setting 3072- and 4096-bit Diffie-Hellman values
The ssl-dh-bits option allows you to specify the number of bits of the prime number used in the Diffie-
Hellman exchange for RSA encryption of the SSL connection. Larger prime numbers are associated with greater
cryptographic strength. You can set DH values from 768 to 4096 bits.

Command syntax is:

config firewall vip
edit server-name

set type server-load-balance
set server-type https
set ssl-dh-bits {768 | 1024 | 1536 | 2048 | 3072 | 4096}

Setting the DH bits to 2048 only provides the equivalent of a symmetric cipher in the range of 112 - 128 bits. This
means that if AES 256 is used then the weakest point is the DH of 2048 and a value of at least 3072 should be
use if the goal is to have 256 bits of security.

FortiGate models with CP9 processors support 3072 and 4096 DH bit sizes in hardware. All FortiGate models up
to and including those with CP8 processors only support offloading DH bit sizes up to 2048 so any sizes larger
than that are done in software and thus are relatively resource intensive.

Additional SSL load balancing and SSL offloading options
The following SSL load balancing and SSL offloading options are only available from the CLI:

ssl-client-session-state-max <sessionstates_int>

Enter the maximum number of SSL session states to keep for the segment of the SSL connection between the
client and the FortiGate unit.

ssl-client-session-state-timeout <timeout_int>

Enter the number of minutes to keep the SSL session states for the segment of the SSL connection between the
client and the FortiGate unit.

ssl-client-session-state-type {both | client | disable | time}
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Select which method the FortiGate unit should use when deciding to expire SSL sessions for the segment of the
SSL connection between the client and the FortiGate unit.

l both: Select to expire SSL session states when either ssl-client-session-state-max or ssl-client-
session-state-timeout is exceeded, regardless of which occurs first.

l count: Select to expire SSL session states when ssl-client-session-state-max is exceeded.
l disable: Select to keep no SSL session states.
l time: Select to expire SSL session states when ssl-client-session-state-timeout is exceeded.

ssl-http-location-conversion {enable | disable}

Select to replace http with https in the reply’s Location HTTP header field. For example, in the reply,
Location: http://example.com/ would be converted to Location: https://example.com/

ssl-http-match-host {enable | disable}

Select to apply Location conversion to the reply’s HTTP header only if the host name portion of Location
matches the request’s Host field, or, if the Host field does not exist, the host name portion of the request’s URI.
If disabled, conversion occurs regardless of whether the host names in the request and the reply match.

For example, if host matching is enabled, and a request contains Host: example.com and the reply contains
Location: http://example.cc/, the Location field does not match the host of the original request and
the reply’s Location field remains unchanged. If the reply contains Location: http://example.com/,
however, then the FortiGate unit detects the matching host name and converts the reply field to Location:
https://example.com/.

This option appears only if ssl-http-location-conversion is enable.

ssl-send-empty-frags {enable | disable}

Select to precede the record with empty fragments to protect from attacks on CBC IV. You might disable this
option if SSL acceleration will be used with an old or buggy SSL implementation which cannot properly handle
empty fragments.

ssl-server-session-state-max <sessionstates_int>

Enter the maximum number of SSL session states to keep for the segment of the SSL connection between the
server and the FortiGate unit.

ssl-server-session-state-timeout <timeout_int>

Enter the number of minutes to keep the SSL session states for the segment of the SSL connection between the
server and the FortiGate unit. This option appears only if ssl-mode is full.

ssl-server-session-state-type {both | count | disable | time}

Select which method the FortiGate unit should use when deciding to expire SSL sessions for the segment of the
SSL connection between the server and the FortiGate unit. This option appears only if ssl-mode is full.

l both: Select to expire SSL session states when either ssl-server-session-state-max or ssl-server-
session-state-timeout is exceeded, regardless of which occurs first.

l count: Select to expire SSL session states when ssl-server-session-state-max is exceeded.
l disable: Select to keep no SSL session states.
l time: Select to expire SSL session states when ssl-server-session-state-timeout is exceeded.

SSL offloading support for Internet Explorer 6
In some cases the Internet Explorer 6 web browser may be able to access real servers. To resolve this issue,
disable the ssl-send-empty-frags option:

config firewall vip
edit vip_name
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set type server-load-balance
set server-type https
set ssl-send-empty-frags disable

end

You can disable this option if SSL acceleration will be used with an old or buggy SSL implementation that cannot
properly handle empty fragments.

Selecting the cipher suites available for SSL load balancing
You can use the following command to view the complete list of cipher suites available for SSL offloading:

config firewall vip
edit <vip-name>

set type server-load-balance
set server-type https
set ssl-algorithm custom

config ssl-cipher-suites
edit 0
set cipher ?

In most configurations the matching cipher suite is automatically selected but you can limit the set of cipher
suites that are available for a given SSL offloading configuration. For example, use the following command to
limit an SSL load balancing configuration to use the three cipher suites that support ChaCha20 and Poly1305:

config firewall vip
edit <vip-name>

set type server-load-balance
set server-type https
set ssl-algorithm custom

config ssl-cipher-suites
edit 1
set cipher TLS-ECDHE-RSA-WITH-CHACHA20-POLY1305-SHA256
next
edit 2
set cipher TLS-ECDHE-ECDSA-WITH-CHACHA20-POLY1305-SHA256
next
edit 3
set cipher TLS-DHE-RSA-WITH-CHACHA20-POLY1305-SHA256
end

end

Disabling SSL/TLS re-negotiation
The vulnerability CVE-2009-3555 affects all SSL/TLS servers that support re-negotiation. FortiOS when
configured for SSL/TLS offloading is operating as a SSL/TLS server. The IETF is working on a TLS protocol
change that will fix the problem identified by CVE-2009-3555 while still supporting re-negotiation. Until that
protocol change is available, you can use the ssl-client-renegotiation option to disable support for
SSL/TLS re-negotiation. The default value of this option is allow, which allows an SSL client to renegotiate. You
can change the setting to deny to abort any attempts by an SSL client to renegotiate. If you select deny as soon
as a ClientHello message indicating a re-negotiation is received from the client FortiOS terminates the TCP
connection.

Since SSL offloading does not support requesting client certificates the only circumstance in which a re-
negotiation is required is when more than 2^32 bytes of data are exchanged over a single handshake. If you are
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sure that this volume of traffic will not occur then you can disable re-negotiation and avoid any possibility of the
attack described in CVE-2009-3555.

The re-negotiation behavior can be tested using OpenSSL. The OpenSSL s_client application has the feature
that the user can request that it do renegotiation by typing “R”. For example, the following shows a successful re-
negotiation against a FortiGate unit configured with a VIP for 192.168.2.100:443:

$ openssl s_client -connect 192.168.2.100:443
CONNECTED(00000003)
depth=1 /C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com
verify error:num=19:self signed certificate in certificate chain
verify return:0
---
Certificate chain
0

s:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Fortigate/CN=FW80CM3909604325/emailAdd
ress=support@fortinet.com
i:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com

1 s:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com

i:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com

---
Server certificate

-----BEGIN CERTIFICATE-----

---certificate not shown---

-----END CERTIFICATE-----

subject=/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Fortigate/CN=FW80CM3909604325/em
ailAddress=support@fortinet.com

issuer=/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com
---
No client certificate CA names sent
---
SSL handshake has read 2370 bytes and written 316 bytes
---
New, TLSv1/SSLv3, Cipher is DHE-RSA-AES256-SHA
Server public key is 1024 bit
Compression: NONE
Expansion: NONE
SSL-Session:

Protocol : TLSv1
Cipher : DHE-RSA-AES256-SHA
Session-ID:
02781E1E368DCCE97A95396FAA82E8F740F5BBA96CF022F6FEC3597B0CC88095
Session-ID-ctx:
Master-Key:

A6BBBD8477A2422D56E57C1792A4EA9C86F37D731E67D0A66E5CDB2B5C76650780C0E7F01CFF851EC44661
86F4C48397
Key-Arg : None
Start Time: 1264453027
Timeout : 300 (sec)
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Verify return code: 19 (self signed certificate in certificate
chain)

---
GET /main.c HTTP/1.0
R
RENEGOTIATING
depth=1 /C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com
verify error:num=19:self signed certificate in certificate chain
verify return:0
HTTP/1.0 200 ok
Content-type: text/plain

/*
* Copyright (C) 2004-2007 Fortinet
*/

#include <stdio.h>
#include "vsd_ui.h"

int main(int argc, char **argv)
{
return vsd_ui_main(argc, argv);
}
closed
$ 

The following is the same test, but this time with the VIP configuration changed to ssl-client-
renegotation deny:

$ openssl s_client -connect 192.168.2.100:443
CONNECTED(00000003)
depth=1 /C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com
verify error:num=19:self signed certificate in certificate chain
verify return:0
---
Certificate chain
0

s:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Fortigate/CN=FW80CM3909604325/emailAdd
ress=support@fortinet.com
i:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com

1 s:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com

i:/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com

---
Server certificate
-----BEGIN CERTIFICATE-----

---certificate not shown---
-----END CERTIFICATE-----

subject=/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Fortigate/CN=FW80CM3909604325/em
ailAddress=support@fortinet.com

issuer=/C=US/ST=California/L=Sunnyvale/O=Fortinet/OU=Certificate
Authority/CN=support/emailAddress=support@fortinet.com
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---
No client certificate CA names sent
---
SSL handshake has read 2370 bytes and written 316 bytes
---
New, TLSv1/SSLv3, Cipher is DHE-RSA-AES256-SHA
Server public key is 1024 bit
Compression: NONE
Expansion: NONE
SSL-Session:

Protocol : TLSv1
Cipher : DHE-RSA-AES256-SHA
Session-ID:
8253331D266DDE38E4D8A04AFCA9CBDED5B1134932CE1718EED6469C1FBC7474
Session-ID-ctx:
Master-Key:

ED05A3EF168AF2D06A486362FE91F1D6CAA55CEFC38A3C36FB8BD74236BF2657D4701B6C1456CEB5BB5EFA
A7619EF12D
Key-Arg : None
Start Time: 1264452957
Timeout : 300 (sec)
Verify return code: 19 (self signed certificate in certificate
chain)

---
GET /main.c HTTP/1.0
R
RENEGOTIATING

19916:error:1409E0E5:SSL routines:SSL3_WRITE_BYTES:ssl handshake failure:s3_pkt.c:530:
Use the following command to check the SSL stats to see that the renegotiations blocked counter is
now 1:

diagnose firewall vip virtual-server stats ssl
ssl

client
connections total 0 active 0 max 0
handshakes total 4 active 0 max 0 completed 4 abbreviated 0
session states total 4 active 4 max 4
cipher-suite failures 0
embryonics total 0 active 0 max 0 terminated 0
renegotiations blocked 1

server
connections total 0 active 0 max 0
handshakes total 3 active 0 max 0 completed 2 abbreviated 1
session states total 1 active 1 max 1
cipher-suite failures 0

internal error 0
bad handshake length 0
bad change cipher spec length 0
pubkey too big 0
persistence

find 0 found 0 clash 0 addr 0 error 0

If the virtual server debug log is examined (diagnose debug appl vs -1) then at the point the re-negotiation is
blocked there is a log:

vs ssl 12 handshake recv ClientHello
vs ssl 12 handshake recv 1
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(0100005403014b5e056c7f573a563bebe0258c3254bbaff7046a461164f34f94f4f3d019c418000026
00390038003500160013000a00330032002f00050004001500120009001400110008000600030201000
00400230000)

vs ssl 12 client renegotiation attempted rejected, abort
vs ssl 12 closing 0 up
vs src 12 close 0 in
vs src 12 error closing
vs dst 14 error closing
vs dst 14 closed
vs ssl 14 close
vs sock 14 free
vs src 12 closed
vs ssl 12 close
vs sock 12 free

IP, TCP, and UDP load balancing

You can load balance all IP, TCP or UDP sessions accepted by the security policy that includes a load balancing
virtual server with the type set to IP, TCP, or UDP. Traffic with destination IP and port that matches the virtual
server IP and port is load balanced. For these protocol-level load balancing virtual servers you can select a load
balance method and add real servers and health checking. However, you can’t configure persistence, HTTP
multiplexing and SSL offloading.

Example HTTP load balancing to three real web servers

In this example, a virtual web server with IP address 192.168.37.4 on the Internet, is mapped to three real web
servers connected to the FortiGate unit dmz1 interface. The real servers have IP addresses 10.10.123.42,
10.10.123.43, and 10.10.123.44. The virtual server uses the First Alive load balancing method. The
configuration also includes an HTTP health check monitor that includes a URL used by the FortiGate unit for get
requests to monitor the health of the real servers.

Connections to the virtual web server at IP address 192.168.37.4 from the Internet are translated and load
balanced to the real servers by the FortiGate unit. First alive load balancing directs all sessions to the first real
server. The computers on the Internet are unaware of this translation and load balancing and see a single virtual
server at IP address 192.168.37.4 rather than the three real servers behind the FortiGate unit.
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Virtual server configuration example

FortiGate unit

Real  S
ervers

Virtual Server IP

192.168.37.4

DMZ1

10.10.10.2

HTTP server IP

10.31.101.42

HTTP server IP

10.31.101.43

HTTP server IP

10.31.101.44

Client IP

172.199.190.25

3
1

2 Source IP 172.199.190.25

Destination IP 192.168.37.4

3
1

2

Source IP 10.10.10.2

Destination IP 10.10.10.[42-44]

HTTP load balancing

virtual server

GUI configuration
Use the following procedures to configure this load balancing setup from the GUI.

To add an HTTP health check monitor

In this example, the HTTP health check monitor includes the URL “/index.html” and theMatched Phrase
“Fortinet products”.

1. Go to Policy & Objects > Health Check.
2. Select Create New.
3. Add an HTTP health check monitor that sends get requests to http://<real_server_IP_address>/index.html and

searches the returned web page for the phrase “Fortinet products”.

Name HTTP_health_chk_1

Type HTTP

Port 80

URL /index.html

Matched Content Fortinet products
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Interval 10 seconds

Timeout 2 seconds

Retry 3

4. Select OK.

To add the HTTP virtual server and the real servers

1. Go to Policy & Objects > Virtual Servers.
2. Select Create New.
3. Add an HTTP virtual server that allows users on the Internet to connect to the real servers on the internal network.

In this example, the FortiGate wan1 interface is connected to the Internet.

Name Load_Bal_VS1

Type HTTP

Interface wan1

Virtual Server IP 192.168.37.4

The public IP address of the web server.

The virtual server IP address is usually a static IP address obtained from
your ISP for your web server. This address must be a unique IP address that
is not used by another host and cannot be the same as the IP address of
the external interface the virtual IP will be using. However, the external IP
address must be routed to the selected interface. The virtual IP address
and the external IP address can be on different subnets. When you add the
virtual IP, the external interface responds to ARP requests for the external
IP address.

Virtual Server Port 80

Load Balance Method First Alive

Persistence HTTP cookie

Health Check HTTP_health_chk_1

HTTP Multiplexing Turn on.

The FortiGate unit multiplexes multiple client into a few connections
between the FortiGate unit and each real HTTP server. This can improve
performance by reducing server overhead associated with establishing
multiple connections.

Preserve Client IP Turn on.

The FortiGate unit preserves the IP address of the client in the X-
Forwarded-For HTTP header.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

2999



Example HTTP load balancing to three real web servers Chapter 26 - Server Load Balancing

4. Add three real servers to the virtual server. Each real server must include the IP address of a real server on the
internal network.
Configuration for the first real server.

IP Address 10.10.10.42

Port 80

Max Connections 0

SettingMax Connections to 0 means the FortiGate unit does not limit the
number of connections to the real server. Since the virtual server uses First
Alive load balancing you may want to limit the number of connections to
each real server to limit the traffic received by each server. In this example,
theMax Connections is initially set to 0 but can be adjusted later if the
real servers are getting too much traffic.

Mode Active

Configuration for the second real server.

IP Address 10.10.10.43

Port 80

Max Connections 0

Mode Active

Configuration for the third real server.

IP Address 10.10.10.44

Port 80

Max Connections 0

Mode Active

To add the virtual server to a security policy

Add a wan1 to dmz1 security policy that uses the virtual server so that when users on the Internet attempt to
connect to the web server’s IP address, packets pass through the FortiGate unit from the wan1 interface to the
dmz1 interface. The virtual IP translates the destination address of these packets from the virtual server IP
address to the real server IP addresses.

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Configure the security policy:

Name Add a name for the policy.

Incoming Interface wan1
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Outgoing Interface dmz1

Source all (or a more specific address)

Destination Load_Bal_VS1

Schedule always

Service HTTP

Action ACCEPT

NAT Select this option and select Use Destination Interface Address.

Log Allowed Traffic Select to log virtual server traffic

4. Select other security policy options as required.
5. Select OK.

CLI configuration
Use the following procedure to configure this load balancing setup from the CLI.

To configure HTTP load balancing

1. Use the following command to add an HTTP health check monitor that sends get requests to http://<real_server_
IP_address>/index.html and searches the returned web page for the phrase “Fortinet products”.

config firewall ldb-monitor
edit HTTP_health_chk_1

set type http
set port 80
set http-get /index.html
set http-match “Fortinet products”
set interval 10
set timeout 2
set retry 3

end

2. Use the following command to add an HTTP virtual server that allows users on the Internet to connect to the real
servers on the internal network. In this example, the FortiGate wan1 interface is connected to the Internet.

config firewall vip
edit Load-Bal_VS1

set type server-load-balance
set server-type http
set ldb-method first-alive
set http-multiplex enable
set http-ip-header enable
set extip 192.168.37.4
set extintf wan1
set extport 80
set persistence http-cookie
set monitor HTTP_health_chk_1

config realservers
edit 1

set ip 10.10.10.42
set port 80

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

3001



Example Basic IP load balancing configuration Chapter 26 - Server Load Balancing

next
edit 2

set ip 10.10.10.43
set port 80

next
edit 3

set ip 10.10.10.44
set port 80

end
end

3. Use the following command to add a security policy that includes the load balance virtual server as the destination
address.

config firewall policy
edit 0

set name <policy-name>
set srcintf wan1
set srcaddr all
set dstintf dmz1
set dstaddr Load-Bal_VS1
set action accept
set schedule always
set service ALL
set nat enable

end

Configure other security policy settings as required.

Example Basic IP load balancing configuration

This example shows how to add a server load balancing virtual IP that load balances all traffic among 3 real
servers. In the example the Internet is connected to port2 and the virtual IP address of the virtual server is
192.168.20.20. The load balancing method is weighted. The IP addresses of the real servers are 10.10.10.1,
10.10.10.2, and 10.10.10.3. The weights for the real servers are 1, 2, and 3. The default weight is 1 and does not
have to be changed for the first real server.

config firewall vip
edit All_Load_Balance

set type server-load-balance
set server-type ip
set extintf port2
set extip 192.168.20.20
set ldb-method weighted

config realservers
edit 1

set ip 10.10.10.1
next
edit 2

set ip 10.10.10.2
set weight 2

next
edit 3

set ip 10.10.10.3
set weight 3

end
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end

Example Adding a server load balance port forwarding virtual IP

In this example, a virtual web server with IP address 192.168.37.4 on the Internet, is mapped to three real web
servers connected to the FortiGate unit dmz1 interface. The real servers have IP addresses 10.10.123.42,
10.10.123.43, and 10.10.123.44. The virtual server uses the First Alive load balancing method.

Each real server accepts HTTP connections on a different port number. The first real server accepts connections
on port 8080, the second on port 8081, and the third on 8082. The configuration also includes an HTTP health
check monitor that includes a URL used by the FortiGate unit for get requests to monitor the health of the real
servers.

Connections to the virtual web server at IP address 192.168.37.4 from the Internet are translated and load
balanced to the real servers by the FortiGate unit. First alive load balancing directs all sessions to the first real
server. The computers on the Internet are unaware of this translation and load balancing and see a single virtual
server at IP address 192.168.37.4 rather than the three real servers behind the FortiGate unit.

Server load balance virtual IP port forwarding

DMZ N
etw

ork

Virtual Server IP

192.168.37.4

DMZ1

10.10.10.2

Real HTTP server IP

10.31.101.44

Real HTTP server IP

10.31.101.43

Real HTTP server IP

10.31.101.44

Client IP

172.199.190.25

3
1

2 Source IP 172.199.190.25

Destination IP 192.168.37.4

Port 80

3
1

2

Source IP 10.10.10.2

Destination IP 10.10.10.[42-44]

Port Range 8080-8082

HTTP load balancing

virtual server

VVirtua111992.168.3

MZ1
10.10.2

To complete this configuration, all of the steps would be the same as in Example Adding a server load balance
port forwarding virtual IP on page 3003 except for configuring the real servers.

To add the real servers to the virtual server

Use the following steps to add three real servers to the virtual server Load_Bal_VS1. These real servers cause the
FortiGate unit to forward HTTP packets to the three real servers on ports 8080, 8081, and 8082.
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1. Go to Policy & Objects > Virtual Servers and edit the Load_Bal_VS1 virtual server.
2. Select Create New.
3. Add the following three real servers. Each real server must include the IP address of a real server on the internal

network and have a different port number.

Configuration for the first real server.

IP Address 10.10.10.42

Port 8080

Max Connections 0

Mode Active

Configuration for the second real server.

IP 10.10.10.43

Port 8081

Max Connections 0

Mode Active

Configuration for the third real server.

IP 10.10.10.44

Port 8082

Max Connections 0

Mode Active

Example Weighted load balancing configuration

This example shows how to using firewall load balancing to load balances all traffic among 3 real servers. In the
example the Internet is connected to port2 and the virtual IP address of the virtual server is 192.168.20.20. The
load balancing method is weighted. The IP addresses of the real servers are 10.10.10.1, 10.10.10.2, and
10.10.10.3. The weights for the real servers are 1, 2, and 3.

This configuration does not include a health check monitor.

GUI configuration
Use the following procedures to configure this load balancing setup from the FortiGate GUI.
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To add the HTTP virtual server

1. Go to Policy & Objects > Virtual Servers.
2. Select Create New.
3. Add an IP virtual server that allows users on the Internet to connect to the real servers on the internal network. In

this example, the FortiGate port2 interface is connected to the Internet.

Name HTTP_weghted_LB

Type IP

Interface port2

Virtual Server IP 192.168.20.20

Load Balance Method Weighted

All other virtual server settings are not required or cannot be changed.

4. UnderReal Servers select Create New.
5. Add three real servers. Because the Load Balancing Method isWeighted, each real server includes a weight.

Servers with a higher weight receive a more sessions.

Configuration for the first real server.

IP Address 10.10.10.1

Weight 1

Max Connections 0

SettingMax Connections to 0 means the FortiGate unit does not limit the
number of connections to the real server.

Mode Active

Configuration for the second real server.

IP Address 10.10.10.2

Weight 2

Max Connections 0

Mode Active

Configuration for the third real server.

IP Address 10.10.10.3

Weight 3

Max Connections 0

Mode Active
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To add the virtual server to a security policy

Add a port2 to port1 security policy that uses the virtual server so that when users on the Internet attempt to
connect to the web server’s IP address, packets pass through the FortiGate unit from the wan1 interface to the
dmz1 interface. The virtual IP translates the destination address of these packets from the virtual server IP
address to the real server IP addresses.

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Configure the security policy:

Name Policy name

Incoming Interface port2

Outgoing Interface port1

Source all (or a more specific address)

Destination HTTP_weghted_LB

Schedule always

Service ALL

Action ACCEPT

NAT Select this option and select Use Destination Interface Address.

4. Select other security policy options as required.
5. Select OK.

CLI configuration
Load balancing is configured from the CLI using the config firewall vip command and by setting type
to server-load-balance. The default weight is 1 and does not have to be changed for the first real server.

Use the following command to add the virtual server and the three weighted real servers.

config firewall vip
edit HTTP_weghted_LB

set type server-load-balance
set server-type ip
set extintf port2
set extip 192.168.20.20
set ldb-method weighted

config realservers
edit 1

set ip 10.10.10.1
next
edit 2

set ip 10.10.10.2
set weight 2

next
edit 3

set ip 10.10.10.3
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set weight 3
end

end

Example HTTP and HTTPS persistence configuration

This example shows how to add a virtual server named HTTP_Load_Balance that load balances HTTP traffic
using port 80 and a second virtual server named HTTPS_Load_Balance that load balances HTTPS traffic using
port 443. The Internet is connected to port2 and the virtual IP address of the virtual server is 192.168.20.20. Both
server load balancing virtual IPs load balance sessions to the same three real servers with IP addresses
10.10.10.2, 10.10.10.2, and 10.10.10.3. The real servers provide HTTP and HTTPS services.

For both virtual servers, persistence is set to HTTP Cookie to enable HTTP cookie persistence.

To add the HTTP and HTTPS virtual servers

1. Go to Policy & Objects > Virtual Servers.
2. Add the HTTP virtual server that includes HTTPCookie persistence.

Name HTTP_Load_Balance

Type HTTP

Interface port2

Virtual Server IP 192.168.20.20

Virtual Server Port 80

In this example the virtual server uses port 8080 for HTTP sessions instead
of port 80.

Load Balance Method Static

Persistence HTTP cookie

3. UnderReal Servers select Create New.
4. Add three real servers.

Configuration for the first real server.

IP Address 10.10.10.1

Port 80

Max Connections 0

Mode Active

Configuration for the second real server.
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IP Address 10.10.10.2

Port 80

Maximum Connections 0

Mode Active

Configuration for the third real server.

IP Address 10.10.10.3

Port 80

Max Connections 0

Mode Active

5. Select OK.
6. Select Create New to add the HTTPS virtual server that also includes HTTPCookie persistence.

Name HTTPS_Load_Balance

Type HTTPS

Interface port2

Virtual Server IP 192.168.20.20

Virtual Server Port 443

Load Balance Method Static

Persistence HTTP cookie

7. UnderReal Servers select Create New
8. Add three real servers.

Configuration for the first real server.

IP Address 10.10.10.1

Port 443

Max Connections 0

Mode Active

Configuration for the second real server.

IP Address 10.10.10.2

Port 443
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Max Connections 0

Mode Active

Configuration for the third real server.

IP Address 10.10.10.3

Port 443

Max Connections 0

Mode Active

To add the virtual servers to security policies

Add a port2 to port1 security policy that uses the virtual server so that when users on the Internet attempt to
connect to the web server’s IP address, packets pass through the FortiGate unit from the wan1 interface to the
dmz1 interface. The virtual IP translates the destination address of these packets from the virtual server IP
address to the real server IP addresses.

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Configure the HTTP security policy:

Name Policy name.

Incoming Interface port2

Outgoing Interface port1

Source all

Destination HTTP_Load_Balance

Schedule always

Service HTTP

Action ACCEPT

NAT Select this option and select Use Destination Interface Address.

4. Select other security policy options as required.
5. Select OK.
6. Select Create New.
7. Configure the HTTP security policy:

Name Policy name.

Incoming Interface port2

Outgoing Interface port1
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Source all

Destination HTTPS_Load_Balance

Schedule always

Service HTTPS

Action ACCEPT

NAT Select this option and select Use Destination Interface Address.

8. Select other security policy options as required.
9. Select OK.

CLI configuration: adding persistence for a specific domain
Load balancing is configured from the CLI using the config firewall vip command and by setting type
to server-load-balance.

For the CLI configuration, both virtual servers include setting http-cookie-domain to .example.org
because HTTP cookie persistence is just required for the example.org domain.

First, the configuration for the HTTP virtual IP:

config firewall vip
edit HTTP_Load_Balance

set type server-load-balance
set server-type http
set extport 8080
set extintf port2
set extip 192.168.20.20
set persistence http-cookie
set http-cookie-domain .example.org

config realservers
edit 1

set ip 10.10.10.1
next
edit 2

set ip 10.10.10.2
next
edit 3

set ip 10.10.10.3
end

end

Second, the configuration for the HTTPS virtual IP. In this configuration you don’t have to set extport to 443
because extport is automatically set to 443 when server-type is set to https.

config firewall vip
edit HTTPS_Load_Balance

set type server-load-balance
set server-type https
set extport 443
set extintf port2
set extip 192.168.20.20
set persistence http-cookie
set http-cookie-domain .example.org
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config realservers
edit 1

set ip 10.10.10.1
next
edit 2

set ip 10.10.10.2
next
edit 3

set ip 10.10.10.3
end

end
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SSL VPN

This document provides a general introduction to SSL VPN technology, explains the features available with SSL
VPN and gives guidelines to decide what features you need to use, and how the FortiGate unit is configured to
implement the features.

The following chapters are included in this document:

Overview provides useful general information about VPN and SSL, how the FortiGate unit implements them, and
gives guidance on how to choose between SSL and IPsec.

Basic configuration explains how to configure the FortiGate unit and the web portal. Along with these
configuration details, this chapter also explains how to grant unique access permissions, how to configure the
SSL encryption key algorithm, and describes the SSL VPN OSPatch Check feature that allows a client with a
specific OS patch to access SSL VPN services.

The SSL VPN client provides an overview of the FortiClient software required for tunnel mode, where to obtain
the software, how to install it, and the configuration information required for remote users to connect to the
internal network.

The SSL VPN web portal provides an overview of the SSL VPN web portal, with explanations of how to use and
configure the web portal features.

Setup examples explores several configuration scenarios with step-by-step instructions. While the information
provided is enough to set up the described SSL VPN configurations, these scenarios are not the only possible SSL
VPN setups.

Troubleshooting provides some general maintenance and troubleshooting procedures for SSL VPNs.
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This chapter describes new SSL VPN features added to FortiOS 5.6.

FortiOS 5.6.4
These features first appeared in FortiOS 5.6.4.

l "Tunnel Mode Client Options logic" on page 3032
l " HTTP header information" on page 3081

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Virtual desktop option no longer supported (442044)

The SSL VPN web portal no longer supports the virtual desktop and its option has been removed from the
interface.

Option to disable FortiClient download in web portal (439736)

You can use the following commands to enable or disable allowing SSL VPN users to download FortiClient from
the SSL VPN web portal. If forticlient-download is enabled, you can select the download method
(direct or over the ssl_vpn). You can also optionally specify a custom URL for downloading the Windows and
Mac OS versions of FortiClient.

Syntax

config vpn ssl web portal
edit <portal name>

set forticlient-download {enable | disable}
set forticlient-download-method {direct | ssl-vpn}
set customize-forticlient-download-url {enable | disable}
set windows-forticlient-download-url <url>
set macos-forticlient-download-url <url>

end

Upgraded OpenSSL to 1.1.x (412033) (...)

OpenSSL has been upgraded to 1.1 to provide more cryptographic algorithms. All 3rd-party libraries that depend
on OpenSSL have also been updated. OpenLDAP has been upgraded to 2.4.45 to be compatible with OpenSSL
1.1. Furthermore, the sslv3 attribute has been removed from vpn.ssl.settings and global.admin-
https-ssl-version.

FortiOS 5.6.1
These features first appeared in FortiOS 5.6.1.
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Added a button to send Ctrl-Alt-Delete to the remote host for VNC and RDP desktop
connections (401807)

Previously, users were unable to send Ctrl-Alt-Delete to the host machine in an SSL VPN remote desktop
connection.

FortiOS 5.6.1 adds a new button that allows users to send Ctrl-Alt-Delete in remote desktop tools (also fixes
412456, preserving the SSL VPN realm after session timeout prompts a logout).

Improved SSL VPN Realms page (0392184)

Implemented minor functional changes to the dialog on the SSL VPN > Realms page:

l URL preview uses info message similar to that seen on the SSL VPN settings dialog.
l Virtual-Host input is now visible when set in the CLI.
l Added help tooltip describing what the virtual-host property does.

Customizable FortiClient Download URL in SSL VPN Web Portal (437883)

A new attribute, customize-forticlient-download-url, is added to vpn.ssl.web.portal.

The added attribute indicates whether to support a customizable download URI for FortiClient. This attribute is
disabled by default. If enabled, two other attributes, windows-forticlient-download-url and macos-
forticlient-download-url, will appear through which the user can customize the download URL for
FortiClient.

Syntax

config vpn ssl web portal
edit <portal>

set customize-forticlient-download-url {enable | disable}
set windows-forticlient-download-url <custom URL for Windows>
set macos-forticlient-download-url <custom URL for Mac OS>

next
end

SSL VPN SSO Support for HTML5 RDP (417248)

This feature adds support for SSO from the SSL VPN portal to an RDP bookmark. If SSO is used, then the
credentials used to login to SSL VPN will be automatically used when connecting to a remote RDP server.

Syntax

conf vpn ssl web user-bookmark
edit <name>

config bookmarks
edit <name>

set apptype rdp
set host "x.x.x.x"
set port <value>
set sso [disable | auto]

next
end

next
end
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FortiOS 5.6.0
These features first appeared in FortiOS 5.6.0.

Remote desktop configuration changes (410648)

If NLA security is chosen when creating an RDP bookmark, a username and password must be provided.
However there may be instances where the user might want to use a blank password, despite being highly
unrecommended. If a username is provided but the password is empty, the CLI will display a warning. See
example CLI below, where the warning appears as a caution before finishing the command:

config vpn ssl web user-group-bookmark
edit <group-name>

config bookmarks
edit <bookmark-name>

set apptype rdp
set host 172.16.200.121
set security nla
set port 3389
set logon-user <username>

next
end

Warning: password is empty. It might fail user authentication and remote desktop
connection would be failed.

end

If no username (logon-user) is specified, the following warning message will appear:

Please enter user name for RDP security method NLA. object set operator error, -2010
discard the setting Command fail. Return code -2010

SSL VPN supports WAN link load balancing interface (396236)

This new feature allows you to set virtual-wan-link as the destination interface in a firewall policy (when
SSL VPN is the source interface) for WAN link load balancing in the GUI and in the CLI. This lets you log into a
FortiGate via SSL VPN for traffic inspection and then have outbound traffic load balanced byWAN link load
balancing.

Syntax

config firewall policy
edit <example>

set dstintf virtual-wan-link
end

SSL VPN login timeout to support high latency (394583)

With long network latency, the FortiGate can timeout the client before it can finish negotiation processes, such as
DNS lookup and time to enter a token. Two new CLI commands under config vpn ssl settings have
been added that allow the login timeout to be configured, replacing the previous hard timeout value. The second
command can be used to set the SSL VPN maximum DTLS hello timeout.

Syntax

config vpn ssl settings
edit <example>
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set login-timeout [10-180] Default is 30 seconds.
set dtls-hello-timeout [10-60] Default is 10 seconds.

end

SSL VPN supports Windows 10 OS check (387276)

A new CLI field has been added to the os-check-list under config vpn ssl web portal to allow OS
checking for Windows 10.

Syntax

config vpn ssl web portal
edit <example>
set os-check enable
config os-check-list windows-10

set action {deny | allow | check-up-to-date}
end

end

SSL VPN DNS suffix per portal and number of portals (383754)

A new CLI command under config vpn ssl web portal to implement a DNS suffix per SSL VPN portal.
Each suffix setting for each specific portal will override the dns-suffix setting under config vpn ssl
settings.

This feature also raises bookmark limits and the number of portals that can be supported, depending on what
FortiGate series model is used:

l 650 portals on 1000D series
l 1300 portals on 2000E series
l 2600 portals on 3000D series

The previous limit for 1000D series models, for example, was 256 portals.

Syntax

config vpn ssl web portal
edit <example>

set dns-suffix <string>
end

New SSL VPN timeout settings (379870)

New SSL VPN timeout settings have been introduced to counter 'Slowloris' and 'R-U-Dead-Yet' vulnerabilities that
allow remote attackers to cause a denial of service via partial HTTP requests.

The FortiGate solution is to add two attributes (http-request-header-timeout and http-request-
body-timeout).

Syntax

config vpn ssl settings
set http-request-header-timeout [1-60] (seconds)
set http-request-body-timeout [1-60] (seconds)

end
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Personal bookmark improvements (377500)

You can now move and clone personal bookmarks in the GUI and CLI.

Syntax

config vpn ssl web user-bookmark
edit 'name'

config bookmarks
move bookmark1 after/before
clone bookmark1 to

next
end

New controls for SSL VPN client login limits (376983)

Removed the limitation of SSL VPN user login failure time, by linking SSL VPN user setting with config user
settings and provided a new option to remove SSL VPN login attempts limitation. New CLI allows the
administrator to configure the number of times wrong credentials are allowed before SSL VPN server blocks an IP
address, and also how long the block would last.

Syntax

config vpn ssl settings
set login-attempt-limit [0-10] Default is 2.
set login-block-time [0-86400] Default is 60 seconds.

end

Unrated category removed from ssl-exempt (356428)

The "Unrated" category has been removed from the SSL Exempt/Web Category list.

Clipboard support for SSL VPN remote desktop connections (307465)

A remote desktop clipboard viewer pane has been added which allows user to copy, interact with and overwrite
remote desktop clipboard contents.
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Overview

As organizations have grown and become more complex, secure remote access to network resources has
become critical for day-to-day operations. In addition, businesses are expected to provide clients with efficient,
convenient services including knowledge bases and customer portals. Employees traveling across the country or
around the world require timely and comprehensive access to network resources. As a result of the growing need
for providing remote/mobile clients with easy, cost-effective and secure access to a multitude of resources, the
concept of a Virtual Private Network (VPN) was developed.

SSL VPNs establish connectivity using SSL, which functions at Levels 4 - 5 (Transport and Session layers).
Information is encapsulated at Levels 6 - 7 (Presentation and Application layers), and SSL VPNs communicate at
the highest levels in the OSI model. SSL is not strictly a Virtual Private Network (VPN) technology that allows
clients to connect to remote networks in a secure way. A VPN is a secure logical network created from physically
separate networks. VPNs use encryption and other security methods to ensure that only authorized users can
access the network. VPNs also ensure that the data transmitted between computers cannot be intercepted by
unauthorized users. When data is encoded and transmitted over the Internet, the data is said to be sent through a
“VPN tunnel”. A VPN tunnel is a non-application oriented tunnel that allows the users and networks to exchange a
wide range of traffic regardless of application or protocol.

The advantages of a VPN over an actual physical private network are two-fold. Rather than utilizing expensive
leased lines or other infrastructure, you use the relatively inexpensive, high-bandwidth Internet. Perhaps more
important though is the universal availability of the Internet. In most areas, access to the Internet is readily
obtainable without any special arrangements or long wait times.

SSL (Secure Sockets Layer) as HTTPS is supported by most web browsers for exchanging sensitive information
securely between a web server and a client. SSL establishes an encrypted link, ensuring that all data passed
between the web server and the browser remains private and secure. SSL protection is initiated automatically
when a user (client) connects to a web server that is SSL-enabled. Once the successful connection is established,
the browser encrypts all the information before it leaves the computer. When the information reaches its
destination, it is decrypted using a secret (private) key. Any data sent back is first encrypted, and is decrypted
when it reaches the client.

FortiOS supports the SSL and TLS versions defined below:

SSL and TLS version support table

Version RFC

SSL 2.0 RFC 6176

SSL 3.0 RFC 6101

TLS 1.0 RFC 2246

TLS 1.1 RFC 4346

TLS 1.2 RFC 5246

3018 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

http://tools.ietf.org/html/rfc6176
http://tools.ietf.org/html/rfc6101
http://tools.ietf.org/html/rfc2246
http://tools.ietf.org/html/rfc4346
http://tools.ietf.org/html/rfc5246


Overview

SSL VPN modes of operation
When a remote client connects to the FortiGate unit, the FortiGate unit authenticates the user based on
username, password, and authentication domain. A successful login determines the access rights of remote
users according to user group. The user group settings specify whether the connection will operate in web-only
mode or tunnel mode.

Web-only mode

Web-only mode provides remote users with a fast and efficient way to access server applications from any thin
client computer equipped with a web browser. Web-only mode offers true clientless network access using any
web browser that has built-in SSL encryption and the Sun Java Runtime Environment (note that there is no
minimum Java/JRE version requirement—any version of Java/JRE currently supported by the supplier of the
Java/JRE for the operating system should work).

Support for SSL VPN web-only mode is built into FortiOS. The feature comprises of an SSL daemon running on
the FortiGate unit, and a web portal, which provides users with access to network services and resources
including HTTP/HTTPS, Telnet, FTP, SMB/CIFS, VNC, RDP, and SSH.

In web-only mode, the FortiGate unit acts as a secure HTML5 HTTPS gateway and authenticates remote users
as members of a user group. After successful authentication, the FortiGate unit redirects the web browser to the
web portal home page and the user can access the server applications behind the FortiGate unit.

When a user starts a connection to a server from the web portal, FortiOS starts the appropriate client application
to communicate with the server. All connections to server applications are new connections from the FortiGate to
the server. Communication between the FortiGate and the user continues to be over HTML5 HTTPS, so all user
communication with the sever is secured by FortiOS. This includes all supported server protocols (HTTP/HTTPS,
Telnet, FTP, SMB/CIFS, VNC, RDP, and SSH).

When the FortiGate unit provides services in web-only mode, a secure connection between the remote client and
the FortiGate unit is established through the SSL VPN security in the FortiGate unit and the SSL security in the
web browser.

FortiGate SSL VPN web portals have a 1- or 2-column page layout and portal functionality is provided through
small applets called widgets. Widget windows can be moved or minimized. The controls within each widget
depend on its function. There are predefined web portals and the administrator can create additional portals.

Configuring the FortiGate unit involves selecting the appropriate web portal configuration in the user group
settings. These configuration settings determine which server applications can be accessed. SSL encryption is
used to ensure traffic confidentiality.

See the FortiOS release notes for information about the operating systems and web browsers supported by SSL
VPN web-only mode.

Tunnel mode

In Tunnel mode, remote clients connect to a FortiGate unit that acts as a secure HTTP/HTTPS gateway and
authenticates remote users as members of a user group.

The SSL VPN client encrypts all traffic from the remote client computer and sends it to the FortiGate unit through
an SSL VPN tunnel over the HTTPS link between the user and the FortiGate unit. Another option is split
tunneling, which ensures that only the traffic for the private network is sent to the SSL VPN gateway. Internet
traffic is sent through the usual unencrypted route. This conserves bandwidth and alleviates bottlenecks.
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When the user initiates a VPN connection with the FortiGate unit through the SSL VPN client, the FortiGate unit
establishes a tunnel with the client and assigns the client a virtual IP address from a range of reserved addresses.
The client uses the assigned IP address as its source address for the duration of the connection. After the tunnel
has been established, the user can access the network behind the FortiGate unit.

Port forwarding mode
While tunnel mode provides a Layer 3 tunnel that users can run any application over, the user needs to install the
tunnel client, and have the required administrative rights to do so. In some situations, this may not be desirable,
yet the simple web mode does not provide enough flexibility for application support (for example, if you wish to
use an email client that communicates with a POP3 server). The port forward mode, or proxy mode, provides this
middle ground between web mode and tunnel mode.

SSL VPN port forwarding listens on local ports on the user’s computer. When it receives data from a client
application, the port forward module encrypts and sends the data to the FortiGate unit, which then forwards the
traffic to the application server.

The port forward module is implemented with a Java applet, which is downloaded and runs on the user’s
computer. The applet provides the up-to-date status information such as addressing and bytes sent and received.

On the user end, the user logs into the FortiGate SSL VPN portal, and selects a port forward bookmark configured
for a specific application. The bookmark defines the server address and port as well as which port to listen to on
the user’s computer.

The user must configure the application on the PC to point to the local proxy instead of
the application server. For information on this configuration change, see the
application documentation.

This mode only supports client/server applications that are using a static TCP port. It
will not support client/server applications using dynamic ports or traffic over UDP.

Application support

With Citrix application servers, the server downloads an ICA configuration file to the user’s PC. The client
application uses this information to connect to the Citrix server. The FortiGate unit will read this file and append a
SOCKS entry to set the SOCKS proxy to ‘localhost’. The Citrix client will then be able to connect to the SSL VPN
port forward module to provide the connection. When configuring the port forwarding module, a selection is
available for Citrix servers.

For Windows Remote Desktop Connections, when selecting the RDP option, the tunnel will launch the RDP client
and connect to the local loopback address after the port forward module has been initiated.

Note that the RDP/VNC web portals are not supported for the following platforms:

Platform Model

FortiGate 80D, 92D, 200D, 200D-POE, 240D, 240D-POE, 600C, 800C, 1000C,
3240C, 3600C, and 5001C

FortiGate-Rugged 90D

FortiWiFi 92D
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Antivirus and firewall host compatibility

The following tables list the antivirus and firewall client software packages that are supported in FortiOS.

Supported Windows XP antivirus and firewall software

Product supported Antivirus Firewall

Symantec Endpoint Protection V11 • •

Kaspersky Antivirus 2009 •

McAfee Security Center v8.1 • •

Trend Micro Internet Security Pro • •

F-Secure Internet Security 2009 • •

Supported Windows 7 32-bit and 64-bit antivirus and firewall software

Product supported Antivirus Firewall

CA Internet Security 2011 • •

AVG Internet Security 2011

F-Secure Internet Security 2011 • •

Kaspersky Internet Security 2011 • •

McAfee Internet Security 2011 • •

Norton 360TM Version 4.0 • •

NortonTM Internet Security 2011 • •

Panda Internet Security 2011 • •

Sophos Security Suite • •

Trend Micro Titanium Internet Security • •

ZoneAlarm Security Suite • •

Symantec Endpoint Protection Small Business Edition 12.0 • •

SSL VPN conserve mode
FortiGate units perform all security profile processing in physical RAM. Since each model has a limited amount of
memory, Kernel conserve mode is activated when the remaining free memory is nearly exhausted or the AV proxy
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has reached the maximum number of sessions it can service.

SSL VPN also has its own conserve mode. The FortiGate enters the SSL VPN conserve mode before the Kernel
conserve mode in an attempt to prevent the Kernel conserve mode from triggering. During the SSL VPN conserve
mode, no new SSL connections are allowed. It starts when free memory is <25% of the total memory (when the
memory on the FortiGate is less than 512Mb) or <10% of the total memory (when the FortiGate has more than
512Mb built in).

To determine if the FortiGate has entered SSL VPN conserve mode - CLI

Run the following command in the CLI Console:

diagnose vpn ssl statistics

Result (showing conserve mode state in red):

SSLVPN statistics:
------------------
Memory unit: 1
System total memory: 2118737920
System free memory: 218537984
SSLVPN memory margin: 314572800
SSLVPN state: conserve

Max number of users: 2
Max number of tunnels: 0
Max number of connections: 13

Current number of users: 1
Current number of tunnels: 0
Current number of connections: 1

Traveling and security
Because SSL VPN provides a means for “on-the-go” users to dial in to the network while away from the office, you
need to ensure that wherever and however they choose to dial in is secure, and not potentially compromising the
corporate network.

Host check

To reinforce security, you can enable a host integrity checker to scan the remote client. The integrity checker
probes the remote client computer to verify that it is safe before access is granted. Security attributes recorded on
the client computer (for example, in the Windows registry, in specific files, or held in memory due to running
processes) are examined and uploaded to the FortiGate unit. For more information, see Host check on page
3045.

Host Check is applicable for both SSL VPNWeb Mode and SSL VPN Tunnel mode.

SSL VPN and IPv6
FortiOS supports SSL VPN with IPv6 addressing, and is available for all the java applets (Telnet, VNC, RDP, and
so on). IPv6 configurations for security policies and addressing include:
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l Policy matching for IPv6 addresses
l Support for DNS resolving in SSL VPN
l Support IPv6 for ping
l FTP applications
l SMB

In essentially any of the following instructions, replace IPv4with IPv6 to achieve the same desired results, but for
IPv6 addresses and configurations.
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Configuring SSL VPN involves a number of configurations within FortiOS that you need to complete to make it all
come together. This chapter describes the components required, and how and where to configure them to set up
the FortiGate unit as an SSL VPN server. The configurations and steps are high level, to show you the procedures
needed, and where to locate the options in FortiOS. For real-world examples, see Setup examples on page 3068.

There are three or four key steps to configuring an SSL VPN tunnel. The first three in the points below are
mandatory, while the others are optional. This chapter outlines these key steps as well as additional
configurations for tighter security and monitoring.

The key steps are:

l Create user accounts and user groups for the remote clients.
(User accounts and groups on page 3024)

l Create a web portal to define user access to network resources.
(Configuring SSL VPN web portals on page 3028)

l Configure the security policies.
(Configuring security policies on page 3037)

l For tunnel-mode operation, add routing to ensure that client tunnel-mode packets reach the SSL VPN interface.
(Routing in tunnel mode on page 3044)

l Setup logging of SSL VPN activities.
(SSL VPN logs on page 3051)

This section contains the following information:

User accounts and groups
The first step for an SSL VPN tunnel is to add the users and user groups that will access the tunnel. You may
already have users defined for other authentication-based security policies.

The user group is associated with the web portal that the user sees after logging in. You can use one policy for
multiple groups, or multiple policies to handle differences between the groups such as access to different
services, or different schedules.

To create a user account:

l In the web-based manager, go to User & Device > User Definition, and select Create New.
l In the CLI, use the commands in config user local.

All users accessing the SSL tunnel must be in a firewall user group. User names can be up to 64 characters long.

To create user groups:

l In the web-based manager, go to User & Device > User Groups and select Create New.
l In the CLI, use the commands in config user group.
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Guest group and SSO group have been removed from config user group and
config vpn ssl web user-group-bookmark.

Authentication

Remote users must be authenticated before they can request services and/or access network resources through
the web portal. The authentication process can use a password defined on the FortiGate unit or optionally use
established external authentication mechanisms such as RADIUS or LDAP.

To authenticate users, you can use a plain text password on the local FortiGate unit, forward authentication
requests to an external RADIUS, LDAP or TACACS+ server, or utilize PKI certificates.

FortiOS supports LDAP password renewal notification and updates through SSL VPN.
Configuration is enabled using the CLI commands:

config user ldap
edit <username>

       set server <domain>
       set password-expiry-warning enable
       set password-renewal enable
   next
end

MAC host check

When a remote client attempts to log in to the portal, you can have the FortiGate unit check against the client’s
MAC address to ensure that only a specific computer or device is connecting to the tunnel. This can ensure better
security should a password be compromised.

MAC addresses can be tied to specific portals and can be either the entire MAC address or a subset of the
address. MAC host checking is configured in the CLI using the folowing commands:

conf vpn ssl web portal
edit portal

set mac-addr-check enable
set mac-addr-action allow

config mac-addr-check-rule
edit "rule1"

set mac-addr-list 01:01:01:01:01:01 08:00:27:d4:06:5d
set mac-addr-mask 48

end
end

IP addresses for users

After the FortiGate unit authenticates a request for a tunnel-mode connection, the FortiGate unit assigns the SSL
VPN client an IP address for the session. The address is assigned from an IP Pool, which is a firewall address
defining an IP address range.
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Take care to prevent overlapping IP addresses. Do not assign to clients any IP
addresses that are already in use on the private network. As a precaution, consider
assigning IP addresses from a network that is not commonly used (for example,
10.254.254.0/24).

To set tunnel-mode client IP address range - web-based manager:

1. Go to Policy & Objects > Addresses and select Create New.
2. Enter an Name, for example, SSL_VPN_tunnel_range.
3. Select a Type of IP Range.
4. In the Subnet/IP Range field, enter the starting and ending IP addresses that you want to assign to SSL VPN

clients, for example 10.254.254.[80-100].
5. In Interface, select Any.
6. Select OK.

To set tunnel-mode client IP address range - CLI:

If your SSL VPN tunnel range is for example 10.254.254.80 - 10.254.254.100, you could enter

config firewall address
edit SSL_tunnel_users

set type iprange
set end-ip 10.254.254.100
set start-ip 10.254.254.80

end

Authentication of remote users

When remote users connect to the SSL VPN tunnel, they must perform authentication before being able to use
the internal network resources. This can be as simple as assigning users with their own passwords, connecting to
an LDAP server or using more secure options. FortiOS provides a number of options for authentication as well as
security option for those connected users.

The web portal can include bookmarks to connect to internal network resources. A web (HTTP/HTTPS) bookmark
can include login credentials so that the FortiGate unit automatically logs the user into the website. This means
that the user logs into the SSL VPN and then does not have to enter any more credentials to visit preconfigured
web sites.

Both the administrator and the end user can configure bookmarks, including SSO bookmarks. To add bookmarks
as a web portal user, see Using the Bookmarks widget on page 3061.

Setting the client authentication timeout

The client authentication timeout controls how long an authenticated user will remain connected. When this time
expires, the system forces the remote client to authenticate again. As with the idle timeout, a shorter period of
time is more secure. The default value is 28800 seconds (8 hours). You can only modify this timeout value in the
CLI.

For example, to change the authentication timeout to 18 000 seconds, enter the following commands in the CLI:

config vpn ssl settings
set auth-timeout 18000

end
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You can also set the idle timeout for the client, to define how long the user does not access the remote resources
before they are logged out.

Additional timeout settings

SSL VPN timeout settings are also available to counter 'Slowloris' and 'R-U-Dead-Yet' vulnerabilities that allow
remote attackers to cause a denial of service via partial HTTP requests.

The FortiGate solution involves two attributes (http-request-header-timeout and http-request-
body-timeout).

CLI syntax

config vpn ssl settings
set http-request-header-timeout [1-60] (seconds)
set http-request-body-timeout [1-60] (seconds)

end

Allow one-time login per user

You can set the SSL VPN tunnel such that each user can only log into the tunnel one time concurrently per user
per login. That is, once logged into the portal, they cannot go to another system and log in with the same
credentials again.

To allow one-time login per user - web-based manager:

Go to VPN > SSL-VPN Portals, select a portal, and enable Limit Users to One SSL-VPN Connection at a
Time. It is disabled by default.

To allow one-time login per user - CLI:

config vpn ssl web portal
edit <portal_name>

set limit-user-logins enable
end

Strong authentication with security certificates

The FortiGate unit supports strong (two-factor) authentication through X.509 security certificates (version 1 or 3).
The FortiGate unit can require clients to authenticate using a certificate, and the client can require the FortiGate
unit to authenticate using a certificate.

You can select the Require Client Certificate option so that clients must authenticate using certificates. The
client browser must have a local certificate installed, and the FortiGate unit must have the corresponding CA
certificate installed.

When the remote client initiates a connection, the FortiGate unit prompts the client browser for its client-side
certificate as part of the authentication process.

To require client authentication by security certificates - web-based manager:

1. Go to VPN > SSL-VPN Settings.
2. Select Require Client Certificate.
3. Select Apply.
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To require client authentication by security certificates - CLI:

config vpn ssl settings
set reqclientcert enable

end

If your SSL VPN clients require strong authentication, the FortiGate unit must offer a CA certificate that the client
browser has installed.

In the FortiGate unit SSL VPN settings, you can select which certificate the FortiGate offers to authenticate itself.
By default, the FortiGate unit offers its factory installed (Fortinet_CA_SSLProxy) certificate from Fortinet to
remote clients when they connect. If you leave the default setting, a warning appears that recommends you
purchase a certificate for your domain and upload it for use.

To enable FortiGate unit authentication by certificate - web-based manager:

1. Go to VPN > SSL-VPN Settings.
2. From the Server Certificate list, select the certificate that the FortiGate unit uses to identify itself to SSL VPN

clients.
3. Select Apply.

To enable FortiGate unit authentication by certificate - CLI:

For example, to use the example_cert certificate

config vpn ssl settings
set servercert example_cert

end

FortiOS will check the server certificate to verify that the certificate is valid. Only valid
server certificates should be used.

NSA Suite B cryptography support

FortiOS supports the use of ECDSA Local Certificates for SSL VPN Suite B. The National Security Agency (NSA)
developed Suite B algorithms in 2005 to serve as a cryptographic base for both classified and unclassified
information at an interoperable level.

FortiOS allows you to import, generate, and use ECDSA certificates defined by the Suite B cryptography set. To
generate ECDSA certificates, use the following command in the CLI:

exec vpn certificate local generate ec <certificate-name_str> <elliptic-curve-name>
<subject_str> [<optional_information>]

Configuring SSL VPN web portals
The SSL VPN portal enables remote users to access internal network resources through a secure channel using a
web browser. FortiGate administrators can configure login privileges for system users as well as the network
resources that are available to the users.
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FortiOS supports LDAP password renewal notification and updates through SSL VPN.
Configuration is enabled using the CLI commands:

config user ldap
edit <username>

       set server <domain>
       set password-expiry-warning enable
       set password-renewal enable
   next
end

This step in the configuration of the SSL VPN tunnel sets up the infrastructure; the addressing, encryption, and
certificates needed to make the initial connection to the FortiGate unit. This step is also where you configure
what the remote user sees with a successful connection. The portal view defines the resources available to the
remote users and the functionality they have on the network.

SSL connection configuration

To configure the basic SSL VPN settings for encryption and login options, go to VPN > SSL-VPN Settings.

Listen on Interface(s) Define the interface which the FortiGate will use to listen for SSL VPN
tunnel requests. This is generally your external interface.

Listen on Port Enter the port number for HTTPS access.

Redirect port 80 to this
login port

Enable to redirect the admin HTTP port to the admin HTTPS port.

There are two likely scenarios for this:

l SSL VPN is not in use, in which case the admin GUI runs on port 443 or
10443, and port 80 is redirected.

l SSL VPN runs on port 443, in which case port 80 is redirected to 443 and
the admin port runs on 10443.

If the administrator chooses to run SSL VPN on port 80, the redirect option
is invalid.

This can also be configured in the CLI as shown below (note that HTTPS-
redirect is disabled by default):

Syntax:

config vpn ssl settings
   set https-redirect [enable | disable]
end

Restrict Access
Restrict accessibility to eitherAllow access from any host or to Limit
access to specific hosts as desired. If selecting the latter, you must
specify the hosts.
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Idle Logout Type the period of time (in seconds) that the connection can remain
inactive before the user must log in again. The range is from 10 to 28800
seconds. Setting the value to 0 will disable the idle connection timeout.
This setting applies to the SSL VPN session. The interface does not time
out when web application sessions or tunnels are up.

Server Certificate

Select the signed server certificate to use for authentication. If you leave
the default setting (Fortinet_CA_SSLProxy), the FortiGate unit offers its
built-in certificate from Fortinet to remote clients when they connect. A
warning appears that recommends you purchase a certificate for your
domain and upload it for use.

Require Client Certificate Select to use group certificates for authenticating remote clients. When the
remote client initiates a connection, the FortiGate unit prompts the client
for its client-side certificate as part of the authentication process.

Address Range

Select Automatically assign addresses or Specify custom IP ranges.
The latter will allow you to select the range or subnet firewall addresses
that represent IP address ranges reserved for tunnel-mode SSL VPN
clients.

DNS Server If you select Specify, you may enter up to two DNS servers (IPv4 or IPv6)
to be provided for the use of clients.

Note: It is possible to implement a unique DNS suffix per SSL VPN portal
using the CLI. Each suffix setting for each specific portal will override the
dns-suffix setting under config vpn ssl settings. This is a
CLI-only option, using the following syntax:

config vpn ssl web portal
edit <example>

set dns-suffix <string>
end

Specify WINS Servers Enable to access options for entering up to two WINS servers (IPv4 or IPv6)
to be provided for the use of clients.

Allow Endpoint
Registration

Select so that FortiClient registers with the FortiGate unit when
connecting. If you configured a registration key by going to System >
Config > Advanced, the remote user is prompted to enter the key. This
only occurs on the first connection to the FortiGate unit.

Portal configuration

The portal configuration determines what the remote user sees when they log in to the portal. Both the system
administrator and the user have the ability to customize the SSL VPN portal.

To view the portals settings page, go to VPN > SSL-VPN Portals.

There are three pre-defined default portal configurations available:

l full-access
l tunnel-access
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l web-access

Each portal type includes similar configuration options. Select between the different portals by double-clicking
one of the default portals in the list. You can also create a custom portal by selecting the Create New option at
the top.

Portal Setting Description

Name The name for the portal.

Limit Users to One SSL-VPN
Connection at a Time

You can set the SSL VPN tunnel such that each user can only log
into the tunnel one time concurrently per user per login. That is,
once logged into the portal, they cannot go to another system and
log in with the same credentials again. This option is disabled by
default.

Tunnel Mode These settings determine how tunnel mode clients are assigned
IPv4 addresses.

Enable Split
Tunneling

Select so that the VPN carries only the traffic for the networks
behind the FortiGate unit. The user’s other traffic follows its normal
route.

If you enable split tunneling, you are required to set the Routing
Address, which is the address that your corporate network is
using. Traffic intended for the Routing Address will not be split
from the tunnel.

Source IP Pools Select an IP Pool for users to acquire an IP address when
connecting to the portal. There is always a default pool available if
you do not create your own.
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Portal Setting Description

Tunnel Mode Client
Options

These options affect how the FortiClient application behaves when
connected to the FortiGate VPN tunnel. When enabled, a check
box for the corresponding option appears on the VPN login screen
in FortiClient, and is not enabled by default.

l Allow client to save password - When enabled, if the user
selects this option, their password is stored on the user’s
computer and will automatically populate each time they connect
to the VPN.

l Allow client to connect automatically - When enabled, if the
user selects this option, when the FortiClient application is
launched, for example after a reboot or system startup,
FortiClient will automatically attempt to connect to the VPN
tunnel.

l Allow client to keep connections alive - When enabled, if the
user selects this option, the FortiClient should try to reconnect
once it detects the VPN connection is down unexpectedly (not
manually disconnected by user).

Enable Web Mode Select to enable web mode access.

Portal Message This is a text header that appears on the top of the web portal.

Theme Select a color styling specifically for the web portal.

Show Session Information
The Show Session Information widget displays the login name
of the user, the amount of time the user has been logged in and
the inbound and outbound traffic statistics.

Show Connection Launcher Displays the Connection Launcher widget in the web portal.

Show Login History Select to include user login history on the web portal.

User Bookmarks Enable to allow users to add their own bookmarks in the web
portal.

Predefined Bookmarks

Select to include bookmarks on the web portal. Bookmarks are
used as links to internal network resources. When a bookmark is
selected from a bookmark list, a pop-up window appears with the
web page. Telnet, VNC, and RDP require a browser plugin. FTP
and Samba replace the bookmarks page with an HTML file-
browser.

Tunnel Mode Client Options logic

The FortiGate will check the logic of Tunnel mode VPN client options.

If auto-connect or keep-alive is enabled, the following warning message will be shown: 'save-password
should be enabled if either auto-connect or keep-alive is enabled.'
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At the end of editing the portal, if either auto-connect or keep-alive is enabled and save-password is
not enabled, the following message will be shown, and adding or editing the portal is not permitted: 'save-
password should be enabled as either auto-connect or keep-alive is enabled.'

Options to allow firewall address to be used in routing table for SSL VPN

If destination Named Address is set in Network > Static Routes and Address Range is set to
Automatically assign addresses in VPN > SSL-VPN Settings, SSL VPN should refresh the routing table
automatically.

If your network configuration does not contain a default SSL VPN portal, you might
receive the error message “Input value is invalid” when you attempt to accessVPN >
SSL-VPN Portals.

To enable a default portal - CLI:

config vpn ssl settings
set default-portal <full-access | tunnel-access |

    web-access>
end

Adding bookmarks

Aweb bookmark can include login credentials to automatically log the SSL VPN user into the website. When the
administrator configures bookmarks, the website credentials must be the same as the user’s SSL VPN
credentials. Users configuring their own bookmarks can specify alternative credentials for the website.

To add a bookmark - web-based manager:

1. On the VPN > SSL-VPN Portals page, ensure Enable User Bookmarks is enabled.
2. Select Create New and enter the following information:

Category Select a category, or group, to include the bookmark. If this is the first
bookmark added, you will be prompted to add a category. Otherwise,
select Create from the drop-down list.

Name Enter a name for the bookmark.

Type Select the type of link from the drop-down list. Telnet, VNC, and RDP
require a browser plugin. FTP and Samba replace the bookmarks page with
an HTML file-browser.

URL Enter the IP address source.

Description Enter a brief description of the link.

Single Sign-On Enable if you wish to use Single Sign-On (SSO) for any links that require
authentication.

When including a link using SSO, be sure to use the entire URL. For
example, http://10.10.1.0/login, rather than just the IP address.
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3. Select OK.
For more configuration options, see Configuring SSL VPN web portals on page 3028.

Personal bookmarks

The administrator has be ability to view bookmarks the remote client has added to their SSL VPN login in the
bookmarks widget. This enables the administrator to monitor and, if needed, remove unwanted bookmarks that
do not meet with corporate policy.

To view and maintain remote client bookmarks, go to VPN > SSL-VPN Personal Bookmarks.

For more information about available bookmark applications, see Applications available in the web portal on page
3060

To enable personal bookmarks:

1. Go to System > Feature Visibility.
2. Enable SSL-VPN Personal Bookmark Management.
3. Select Apply.

Moving and cloning bookmarks

The administrator also has the ability to move and clone personal bookmarks in the GUI and CLI.

CLI syntax

config vpn ssl web user-bookmark
edit 'name'

config bookmarks
move bookmark1 after/before
clone bookmark1 to

next
end

Supporting browsers without plugins (Citrix/Port forward) - CLI only

CLI syntax

config vpn ssl web user-bookmark
edit <name>

config bookmarks
edit "citrix-address"

set apptype citrix
set description "my citrix server"
set usl "https://my.citrix.server.com"
set sso enable

next
end

next
end

Group-based SSL VPN bookmarks

The administrator can add bookmarks for groups of users. SSL VPN will only output the matched group-name
entry to the client. This can only be done via the CLI.
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To add group-based SSL VPN bookmarks - CLI:

config vpn ssl web portal
edit "portal-name"

set user-group-bookmark enable*/disable
next

end
config vpn ssl web user-group-bookmark

edit "group-name"
config bookmark

edit "bookmark1"
....
next

end
next

end

Remote desktop bookmark creation with no password

If NLA security is chosen when creating an RDP bookmark, a username and password must be provided.
However there may be instances where the user might want to use a blank password, despite being highly
unrecommended. If a username is provided but the password is empty, the CLI will display a warning. See
example CLI below, where the warning appears as a caution before finishing the command:

config vpn ssl web user-group-bookmark
edit <group-name>

config bookmarks
edit <bookmark-name>

set apptype rdp
set host 172.16.200.121
set security nla
set port 3389
set logon-user <username>

next
end

Warning: password is empty. It might fail user authentication and remote desktop
connection would be failed.

end

If no username (logon-user) is specified, the following warning message will appear:

Please enter user name for RDP security method NLA. object set operator error, -2010
discard the setting Command fail. Return code -2010

SSO support for HTML5 RDP

This feature adds support for SSO from the SSL VPN portal to an RDP bookmark. If SSO is used, then the
credentials used to login to SSL VPN will be automatically used when connecting to a remote RDP server.

This option is only available in CLI.

To configure SSO support for HTML5 RDP - CLI:

conf vpn ssl web user-bookmark
edit <name>

config bookmarks
edit <name>

set apptype rdp
set host "x.x.x.x"
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set port <value>
set sso [disable | auto]

next
end

next
end

SSL VPN Realms

You can go to VPN > SSL-VPN Realms and create custom login pages for your SSL VPN users. You can use
this feature to customize the SSL VPN login page for your users and also to create multiple SSL VPN logins for
different user groups.

In order to create a custom login page using the web-based manager, this feature must be enabled using
Feature Select.

Before you begin, copy the default login page text to a separate text file for safe-
keeping. Afterward, if needed, you can restore the text to the original version.

To configure SSL VPN Realms - web-based manager:

1. Configure a custom SSL VPN login by going to VPN > SSL-VPN Realms and selecting Create New. Users
access different portals depending on the URL they enter.

2. The first option in the custom login page is to enter the path of the custom URL.
This path is appended to the address of the FortiGate unit interface to which SSL VPN users connect. The actual
path for the custom login page appears beside the URL path field.

3. You can also limit the number of users that can access the custom login at any given time.
4. You can use HTML code to customize the appearance of the login page.
5. After adding the custom login, you must associate it with the users that will access the custom login. Do this by

going to VPN > SSL-VPN Settings and adding a rule to the Authentication/Portal Mapping section.
6. UnderAuthentication/Portal Mapping, clickCreate New and select the user group(s) and the associated

Realm.

To configure SSL VPN Realms - CLI:

config vpn ssl web realm
edit <url-path>

set login-page <content_str>
set max-concurrent-user <int>
set virtual-host <hostname_str>

end

Where the following variables are set:

Variable Description Default

edit <url-path> Enter the URL path to access the SSL-VPN login
page.
Do not include “http://”.

No
default.
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Variable Description Default

login-page <content_str> Enter replacement HTML for SSL-VPN login page. No
default.

max-concurrent-user <int> Enter the maximum number of concurrent users
allowed. Range 0-65 535. 0 means unlimited.

0

virtual-host <hostname_str> Enter the virtual host name for this realm. Optional.
Maximum length 255 characters.

No
default.

Customizable FortiClient download URL

The attribute customize-forticlient-download-url (disabled by default) can be enabled to allow
users to customize the download URL for FortiClient. This option is only available in CLI.

If enabled, two other attributes, windows-forticlient-download-url and macos-forticlient-
download-url, will appear.

To configure a customizable FortiClient download URL- CLI:

config vpn ssl web portal
edit <portal>

set customize-forticlient-download-url {enable | disable}
set windows-forticlient-download-url <custom URL for Windows>
set macos-forticlient-download-url <custom URL for Mac OS>

next
end

Disabling FortiClient download in the web portal

Use the following syntax to disable FortiClient download in the web portal.

config vpn ssl web portal
edit <portal name>

set forticlient-download disable
next

end

Configuring security policies
You will need at least one SSL VPN security policy. This is an identity-based policy that authenticates users and
enables them to access the SSL VPN web portal. The SSL VPN user groups named in the policy determine who
can authenticate and which web portal they will use. From the web portal, users can access protected resources
or download the SSL VPN tunnel client application.

This section contains the procedures needed to configure security policies for web-only mode operation and
tunnel-mode operation. These procedures assume that you have already completed the procedures outlined in
Configuring security policies on page 3037.

If you will provide tunnel mode access, you will need a second security policy—an ACCEPT tunnel mode policy to
permit traffic to flow between the SSL VPN tunnel and the protected networks.
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Firewall addresses

Before you can create security policies, you need to define the firewall addresses you will use in those policies.
For both web-only and tunnel mode operation, you need to create firewall addresses for all of the destination
networks and servers to which the SSL VPN client will be able to connect.

For tunnel mode, you will already have defined firewall addresses for the IP address ranges that the FortiGate
unit will assign to SSL VPN clients.

The source address for your SSL VPN security policies will be the predefined “all” address. Both the address and
the netmask are 0.0.0.0. The “all” address is used because VPN clients will be connecting from various
addresses, not just one or two known networks. For improved security, if clients will be connecting from one or
two known locations you should configure firewall addresses for those locations, instead of using the “all”
address.

To create a firewall address, in the web-based manager, go to Policy & Objects > Objects > Addresses, and
select Create New.

Create an SSL VPN security policy

At minimum, you need one SSL VPN security policy to authenticate users and provide access to the protected
networks. You will need additional security policies only if you have multiple web portals that provide access to
different resources. You can use one policy for multiple groups, or multiple policies to handle differences between
the groups such as access to different services, or different schedules.

The SSL VPN security policy specifies:

l The incoming interface that corresponds to the ssl.root interface.
l The SSL VPN user groups that can use the security policy.
l The times (schedule) and types of services that users can access.
l The UTM features and logging that are applied to the connection.

Do not use ALL as the destination address. If you do, you will see the “Destination
address of Split Tunneling policy is invalid” error when you enable Split Tunneling.

To create an SSL-VPN security policy - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information:

Incoming Interface Select the virtual SSL VPN interface, such as ssl.root.

Outgoing Interface Select the FortiGate network interface that connects to the protected
network.

Source Select to allow access only to holders of a (shared) group certificate. The
holders of the group certificate must be members of an SSL VPN user
group, and the name of that user group must be present in the Allowed
field. See Configuring security policies on page 3037.
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Destination Address Select the firewall address you created that represents the networks and
servers to which the SSL VPN clients will connect.

If you want to associate multiple firewall addresses or address groups with
the Destination Interface/Zone, from Destination Address, select the
plus symbol. In the dialog box, move the firewall addresses or address
groups from the Available Addresses section to theMembers section,
then select OK.

Schedule Select always.

Service Select services in the left list and use the right arrow button to move them
to the right list. Select the ALL service to allow the user group access to all
services.

Action Select Accept.

Your identity-based policies are listed in the security policy table. The FortiGate unit searches the table from the
top down to find a policy to match the client’s user group. Using the move icon in each row, you can change the
order of the policies in the table to ensure the best policy will be matched first. You can also use the icons to edit
or delete policies. Furthermore, you can drag and drop policies in the policy list to rearrange their order.

To create an SSL VPN security policy - CLI:

Create the SSL VPN security policy by entering the following CLI commands.

config firewall policy
edit <id>

set srcintf ssl.root(sslvpn tunnel interface)
set dstintf port2
set srcaddr all
set dstaddr OfficeLAN
set nat enable

end

Create a tunnel mode security policy

If your SSL VPN will provide tunnel mode operation, you need to create a security policy to enable traffic to pass
between the SSL VPN virtual interface and the protected networks. This is in addition to the SSL VPN security
policy that you created in the preceding section.

The SSL VPN virtual interface is the FortiGate unit end of the SSL tunnel that connects to the remote client. It is
named ssl.<vdom_name>. In the root VDOM, for example, it is named ssl.root. If VDOMs are not enabled
on your FortiGate unit, the SSL VPN virtual interface is also named ssl.root.

To configure the tunnel mode security policy - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and select OK.

Incoming Interface Select the virtual SSL VPN interface, such as ssl.root.
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Outgoing Interface Select the FortiGate network interface that connects to the protected
network.

Source Address Select the firewall address you created that represents the IP address
range assigned to SSL VPN clients, such as SSL_VPN_tunnel_users.

Source User(s) Select to allow access only to holders of a (shared) group certificate. The
holders of the group certificate must be members of an SSL VPN user
group, and the name of that user group must be present in the Allowed
field. See Configuring security policies on page 3037.

Destination Address Select the firewall address that represents the networks and servers to
which the SSL VPN clients will connect.

To select multiple firewall addresses or address groups, select the plus sign
next to the drop-down list.

Schedule Select always.

Service Select services in the left list and use the right arrow button to move them
to the right list. Select the ALL service to allow the user group access to all
services.

Action Select Accept.

Enable NAT Select Enable NAT. (Optional)

To configure the tunnel mode security policy - CLI:

config firewall policy
edit <id>

set srcintf ssl.root(sslvpn tunnel interface)
set dstintf <dst_interface_name>
set srcaddr <tunnel_ip_address>
set dstaddr <protected_network_address_name>
set schedule always
set service ALL
set nat enable

end

This policy enables the SSL VPN client to initiate communication with hosts on the protected network. If you want
to enable hosts on the protected network to initiate communication with the SSL VPN client, you should create
another Accept policy like the preceding one but with the source and destination settings reversed.

You must also add a static route for tunnel mode operation.

Routing for tunnel mode

If your SSL VPN operates in tunnel mode, you must add a static route so that replies from the protected network
can reach the remote SSL VPN client.

To add the tunnel mode route - web-based manager:

1. Go to Network > Static Routes and select Create New.

For low-end FortiGate units, go to System > Network > Routing and select Create New.
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2. Enter the Destination IP/Mask of the tunnel IP address that you assigned to the users of the web portal.
3. Select the SSL VPN virtual interface for the Device.
4. Select OK.

To add the tunnel mode route - CLI:

If you assigned 10.11.254.0/24 as the tunnel IP range, you would enter:

config router static
edit <id>

set device ssl.root
set dst 10.11.254.0/24

end

Split tunnel Internet browsing policy

With split tunneling disabled, all of the SSL VPN client’s requests are sent through the SSL VPN tunnel. But the
tunnel mode security policy provides access only to the protected networks behind the FortiGate unit. Clients will
receive no response if they attempt to access Internet resources. You can enable clients to connect to the
Internet through the FortiGate unit using a split tunnel Internet browsing policy.

To add an Internet browsing policy:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and select OK.

Incoming Interface Select the virtual SSL VPN interface (ssl.root, for example).

Outgoing Interface Select the FortiGate network interface that connects to the Internet.

Source Select the firewall address you created that represents the IP address
range assigned to SSL VPN clients.

Destination Address Select All.

Action Select Accept.

Enable NAT Select Enable.

To configure the Internet browsing security policy - CLI:

To enable browsing the Internet through port1, you would enter:

config firewall policy
edit 0

set srcintf ssl.root
set dstintf port1
set srcaddr SSL_tunne_users
set dstaddr all
set schedule always
set service ALL
set nat enable

end

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

3041



Basic configuration

Enabling a connection to an IPsec VPN

You might want to provide your SSL VPN clients access to another network, such as a branch office, that is
connected by an IPsec VPN. To do this, you need only to add the appropriate security policy.

Route-based connection

To configure interconnection with a route-based IPsec VPN - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and select OK.

Incoming Interface Select the virtual SSL VPN interface (ssl.root, for example).

Outgoing Interface Select the virtual IPsec interface for your IPsec VPN.

Source Select the firewall address that represents the IP address range assigned
to SSL VPN clients.

Destination Address Select the address of the IPsec VPN remote protected subnet.

Action Select ACCEPT.

Enable NAT Enable.

To configure interconnection with a route-based IPsec VPN - CLI:

If, for example, you want to enable SSL VPN users to connect to the private network (address name OfficeAnet)
through the toOfficeA IPsec VPN, you would enter:

config firewall policy
edit 0

set srcintf ssl.root
set dstintf toOfficeA
set srcaddr SSL_tunnel_users
set dstaddr OfficeAnet
set action accept
set nat enable
set schedule always
set service ALL

end

Policy-based connection

To configure interconnection with a policy-based IPsec VPN - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and select OK.

Incoming Interface Select the virtual SSL VPN interface (ssl.root, for example).

Outgoing Interface Select the FortiGate network interface that connects to the Internet.
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Source Select the firewall address that represents the IP address range assigned
to SSL VPN clients.

Destination Address Select the address of the IPsec VPN remote protected subnet.

3. Configure inbound NAT from the CLI:
config firewall policy

edit 0
set natinbound enable

end

To configure interconnection with a policy-based IPsec VPN - CLI:

If, for example, you want to enable SSL VPN users to connect to the private network (address name OfficeAnet)
through the OfficeA IPsec VPN, you would enter:

config firewall policy
edit 0

set srcintf ssl.root
set dstintf port1
set srcaddr SSL_tunnel_users
set dstaddr OfficeAnet
set action ipsec
set schedule always
set service ALL
set inbound enable
set outbound enable
set natinbound enable
set vpntunnel OfficeA

end

In this example, port1 is connected to the Internet.

Configuring encryption key algorithms
The FortiGate unit supports a range of cryptographic cipher suites to match the capabilities of various web
browsers. The web browser and the FortiGate unit negotiate a cipher suite before any information (for example, a
user name and password) is transmitted over the SSL link. You can only configure encryption key algorithms for
SSL VPN in the CLI.

To configure encryption key algorithms - CLI:

Use the following CLI command,

config vpn ssl settings
set algorithm <cipher_suite>

end

where one of the following variables replaces <cipher_suite>:

Variable Description

low Use any cipher suite; AES, 3DES, RC4, DES, or ChaCha.
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Variable Description

medium Use a 128-bit or greater cipher suite; AES, 3DES, RC4, or ChaCha.

high Use a cipher suite greater than 128 bits; AES or ChaCha.

Note that the algorithm <cipher_suite> syntax is only available when the sslvpn-enable attribute is
set to enable.

Controlling the use of specific cipher suites

Administrators can ban the use of specific cipher suites in the CLI for SSL VPN, so PCI-DSS (Payment Card
Industry Data Security Standard) certification can be met.

To ban the use of specific cipher suites for SSL VPN - CLI:

config vpn ssl settings
set banned-cipher [RSA | DH | DHE | ECDH | ECDHE | DSS | ECDSA | AES | AESGCM |

CAMELLIA | 3DES | SHA1 | SHA256 | SHA384 | STATIC]

Additional configuration options
Beyond the basics of setting up the SSL VPN, you can configure a number of other options that can help to
ensure your internal network is secure and can limit the possibility of attacks and viruses entering the network
from an outside source.

Routing in tunnel mode

If you are creating a SSL VPN connection in tunnel mode, you need to add a static route so that replies from the
protected network can reach the remote SSL VPN client.

To add the tunnel mode route - web-based manager:

1. Go to Network > Static Routes and select Create New.
2. Enter the Destination IP/Mask of the tunnel IP address that you assigned to the users of the web portal.
3. Select the SSL VPN virtual interface for the Device.
4. Select OK.

To add the tunnel mode route - CLI:

If you assigned 10.11.254.0/24 as the tunnel IP range, you would enter:

config router static
edit <id>

set device ssl.root
set dst 10.11.254.0/24

end

Changing the port number for web portal connections

You can specify a different TCP port number for users to access the web portal login page through the HTTPS
link. By default, the port number is 443 and users can access the web portal login page using the following default
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URL:

https://<FortiGate_IP_address>:443/remote/login

where <FortiGate_IP_address> is the IP address of the FortiGate interface that accepts connections from
remote users.

To change the SSL VPN port - web-based manager:

1. If Current VDOM appears at the bottom left of the screen, select Global from the list of VDOMs.
2. Go to VPN > SSL-VPN Settings.
3. Type an unused port number in the Listen on Port field and select Apply.

To change the SSL VPN port - CLI:

This is a global setting. For example, to set the SSL VPN port to 10443, enter the following:

config vpn ssl settings
set port 10443

end

HTTP to HTTPS redirect support

The admin HTTP port can be redirected to the admin HTTPS port. This is enabled in VPN > SSL-VPN Settings
using the option Redirect port 80 to this login port.

There are two likely scenarios for this:

l SSL VPN is not in use, in which case the admin GUI runs on port 443 or 10443, and port 80 is redirected.
l SSL VPN runs on port 443, in which case port 80 is redirected to 443 and the admin port runs on 10443.

If the administrator chooses to run SSL VPN on port 80, the redirect option is invalid.

This can also be configured in the CLI as described below:

To redirect HTTP to HTTPS port - CLI:

config vpn ssl settings
set https-redirect [enable | disable] (default: disabled)

end

SSL offloading

To configure SSL offloading, which allows or denies client renegotiation, you must use the CLI. This helps to
resolve the issues that affect all SSL and TLS servers that support renegotiation, identified by the Common
Vulnerabilities and Exposures system in CVE-2009-3555. The SSL offloading renegotiation feature is considered
a workaround until the IETF permanently resolves the issue.

The CLI command is ssl-client-renegotiation and is found under the config firewall vip
syntax.

Host check

When you enable AV, FW, or AV-FW host checking in the web portal Security Control settings, each client is
checked for security software that is recognized by the Windows Security Center. As an alternative, you can
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create a custom host check that looks for security software selected from the Host Check list. For more
information, see Additional configuration options on page 3044.

The Host Check list includes default entries for many security software products.

Host integrity checking is only possible with client computers running Microsoft
Windows platforms.

To configure host checking - CLI:

To configure the full-access portal to check for AV and firewall software on client Windows computers, you would
enter the following:

config vpn ssl web portal
edit full-access

set host-check av-fw
end

To configure the full-access portal to perform a custom host check for FortiClient Host Security AV and firewall
software, you would enter the following:

config vpn ssl web portal
edit full-access

set host-check custom
set host-check-policy FortiClient-AV FortiClient-FW

end

Replacing the host check error message

You can add your own host security check error message using either the web-based manager or the CLI. The
default message reads: “Your PC does not meet the host checking requirements set by the firewall. Please check
that your OS version or antivirus and firewall applications are installed and running properly or you have the right
network interface.”

To replace the host check error message - web-based manager:

1. Navigate to System > Replacement Messages and select Extended View in the upper right corner.
2. Scroll down to SSL VPN and select Hostcheck Error Message.
3. Edit the text in the right-hand column below and select Save.

If you are unhappy with the new message, you can restore the message to its default by selecting Restore
Default instead of Save.

To replace the host check error message - CLI:

Configure the host check error message using the following command.

config system replacemsg sslvpn hostcheck-error

Creating a custom host check list

You can add your own software requirements to the host check list using the CLI. Host integrity checking is only
possible with client computers running Microsoft Windows platforms. Enter the following commands:

config vpn ssl web host-check-software
edit <software_name>
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set guid <guid_value>
set type <av | fw>
set version <version_number>

end

If known, enter the Globally Unique Identifier (GUID) for the host check application. Windows uses GUIDs to
identify applications in the Windows Registry. The GUID can be found in the Windows registry in the HKEY_
CLASSES_ROOT section.

To obtain the exact versioning, in Windows, right-click on the .EXE file of the application and select Properties,
then select the Version tab.

Example Tunnel Mode Host Check - Registry Key Check

l Check to see if a required registry key is present:

config vpn ssl web host-check-software
edit <computer_name>

config check-item-list
edit 1

set target "HKEY_LOCAL_
MACHINE\\SYSTEM\\CurrentControlSet\\Control\\ComputerName\\ActiveCompute
rName:ComputerName=WINXP32SP3B62"

set type registry <<<-----
next

end
next

end

Example Tunnel Mode Host Check - Application Running Check

l Check to see if a required application is isntalled and/or running:

config vpn ssl web host-check-software
edit "calc"

config check-item-list
edit 1

set target "calc.exe"
set type process <<<-----

next
end

next
end

Example Tunnel Mode Host Check - File Check

l Check to see if a specific file exists at a specific location:

config vpn ssl web host-check-software
edit "putty"

config check-item-list
edit 1

set target "C:\\software\\putty.txt"
set md5s <ENC>

next
end

next
end
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Configuring virtual desktop

Available for 32-bit Windows XP, Windows Vista, and Windows 7 client PCs, the virtual desktop feature
completely isolates the SSL VPN session from the client computer’s desktop environment. All data is encrypted,
including cached user credentials, browser history, cookies, temporary files, and user files created during the
session. When the SSL VPN session ends normally, the files are deleted. If the session ends due to a
malfunction, files might remain, but they are encrypted so that the information is protected.

When the user starts an SSL VPN session that has virtual desktop enabled, the virtual desktop replaces the user’s
normal desktop. When the virtual desktop exits, the user’s normal desktop is restored.

Virtual desktop requires the Fortinet cache cleaner plugin. If the plugin is not present, it automatically downloads
to the client computer.

To enable virtual desktop :

To enable virtual desktop on the full-access portal and apply the application control list ‘List1’, for example, you
would enter:

config vpn ssl web portal
edit full-access

set virtual-desktop enable
set virtual-desktop-app-list List1

end

Configuring virtual desktop application control

You can control which applications users can run on their virtual desktop. To do this, you create an Application
Control List of either allowed or blocked applications. When you configure the web portal, you select the list to
use.

Configure the application control list in the CLI.

To create an Application Control List - CLI:

If you want to add ‘BannedApp’ to ‘List1’, a list of blocked applications, you would enter:

config vpn ssl web virtual-desktop-app-list
edit "List1"

set action block
config apps

edit "BannedApp"
set md5s "06321103A343B04DF9283B80D1E00F6B"

end
end

Configuring client OS Check

The SSLVPN client OS Check feature can determine if clients are running the Windows 2000, Windows XP,
Windows Vista, Windows 7, or Windows 10 operating system. You can configure the OSCheck to do any of the
following:

l Allow the client access.
l Allow the client access only if the operating system has been updated to a specified patch (service pack) version.
l Deny the client access.

The OSCheck has no effect on clients running other operating systems.
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The Windows patch check enables you to define the minimum Windows version and patch level allowed when
connecting to the SSL VPN portal. When the user attempts to connect to the web portal, FortiOS performs a
query on the version of Windows the user has installed. If it does not match the minimum requirement, the
connection is denied. The Windows patch check is configured in the CLI.

To specify the acceptable patch level, you set the latest-patch-level and the tolerance. The lowest
acceptable patch level is latest-patch-level minus tolerance. In this case, latest-patch-level is
3 and tolerance is 1, so 2 is the lowest acceptable patch level.

To configure OS Check:

OSCheck is configurable only in the CLI.

config vpn ssl web portal
edit <portal_name>
set os-check enable

config os-check-list [windows-2000 | windows-xp | windows-vista | windows-7 |
windows-10]

set action [allow | check-up-to-date | deny]
set latest-patch-level [disable | 0 - 255]
set tolerance <tolerance_num>

end
end

Host check for Windows firewall

The Windows built-in firewall does not have a GUID in root\securitycenter or root\securitycenter2, but you can use
a registry value to detect the firewall status.

If Windows firewall is on, the following registry value will be set to 1:

l KeyName:HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SharedAccess\Parameters\
FirewallPolicy\StandardProfile

l ValueName: EnableFirewall

In FortiOS, use the registry-value-check feature to define the Windows Firewall software by entering the following
in the CLI:

config vpn ssl web host-check-software
edit "Microsoft-Windows-Firewall"

config check-item-list
edit 1

set target
"HKLM\\SYSTEM\\CurrentControlSet\\Services\\SharedAccess\\Parameters\\Firew
allPolicy\\StandardProfile:EnableFirewall==1"

set type registry
next
edit 2

set target
"HKLM\\SYSTEM\\CurrentControlSet\\Services\\SharedAccess\\Parameters\\Firew
allPolicy\\PublicProfile:EnableFirewall==1"

set type registry
next
edit 3

set target
"HKLM\\SYSTEM\\CurrentControlSet\\Services\\SharedAccess\\Parameters\\Firew
allPolicy\\DomainProfile:EnableFirewall==1"

set type registry
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next
end

set type fw
next
set host-check custom
set host-check-policy Microsoft-Windows-Firewall

Adding WINS and DNS services for clients

You can specify the WINS or DNS servers that are made available to SSL-VPN clients.

DNS servers provide the IP addresses that browsers need to access web sites. For Internet sites, you can specify
the DNS server that your FortiGate unit uses. If SSL VPN users will access intranet sites using URLs, you need to
provide them access to the intranet’s DNS server. You specify a primary and a secondary DNS server.

AWINS server provides IP addresses for named servers in a Windows domain. If SSL VPN users will access a
Windows network, you need to provide them access to the domain WINS server. You specify a primary and a
secondaryWINS server.

To specify WINS and DNS services for clients - web-based manager:

1. Go to VPN > SSL-VPN Settings.
2. Next to DNS Server select Specify.
3. Enter the IP addresses of DNS servers in the DNS Server fields as needed. Fields are available for both IPv4 and

IPv6 addresses.
4. Select Specify WINS Servers, and enter the IP addresses of WINS servers in theWINS Server fields as

needed. Fields are available for both IPv4 and IPv6 addresses.
5. Select Apply.

To specify WINS and DNS services for clients - CLI:

config vpn ssl settings
set dns-server1 <address_ipv4>
set dns-server2 <address_ipv4>
set wins-server1 <address_ipv4>
set wins-server2 <address_ipv4>

end

Idle timeout

The idle timeout setting controls how long the connection can remain idle before the system forces the remote
user to log in again. For security, keep the default value of 5000 seconds or less. Set the timeout value to 0 to
disable idle timeouts.

To set the idle timeout - web-based manager:

1. Go to VPN > SSL-VPN Settings and enable Idle Logout.
2. In the Inactive For field, enter the timeout value.

The valid range is from 10 to 28800 seconds.

3. Select Apply.
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To set the idle timeout - CLI:

config vpn ssl settings
set idle-timeout <seconds_int>

end

Login timeout

With long network latency, the FortiGate can timeout the client before it can finish negotiation processes, such as
DNS lookup and time to enter a token. Two CLI commands under config vpn ssl settings allow the
login timeout to be configured, replacing the previous hard timeout value. The second command can be used to
set the SSL VPN maximum DTLS hello timeout.

CLI syntax

config vpn ssl settings
edit <example>

set login-timeout [10-180] Default is 30 seconds.
set dtls-hello-timeout [10-60] Default is 10 seconds.

end

Login failure limit

The following CLI allows the administrator to configure the number of times wrong credentials are allowed before
the SSL VPN server blocks an IP address, and also how long the block would last.

CLI syntax

config vpn ssl settings
set login-attempt-limit [0-10] Default is 2.
set login-block-time [0-86400] Default is 60 seconds.

end

SSL VPN logs

Logging is available for SSL VPN traffic so you can monitor users connected to the FortiGate unit and their
activity.

To enable logging of SSL VPN events - web-based manager:

1. Go to Log & Report > Log Settings.
2. Enable Event Logging, and select VPN activity event.
3. Select Apply.
To view the SSL VPN log data, in the web-based manager, go to Log & Report and select either the Event Log
or Traffic Log.

In event log entries, look for the sub-types “sslvpn-session” and “sslvpn-user”.

For information about how to interpret log messages, see the FortiGate Log Message Reference.

Monitoring active SSL VPN sessions

You can go to User & Device > Monitor to view a list of active SSL VPN sessions. The list displays the user
name of the remote user, the IP address of the remote client, and the time the connection was made. You can
also see which services are being provided, and delete an active web session from the FortiGate unit.
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To monitor SSL VPNs - web-based manager:

To view the list of active SSL VPN sessions, go toMonitor > SSL-VPN Monitor.

When a tunnel-mode user is connected, the Description field displays the IP address that the FortiGate unit
assigned to the remote host.

If required, you can end a session/connection by selecting its checkbox and then clicking the Delete icon.

Importing and using a CA-signed SSL certificate

Use the following set of instructions to import a CA-signed SSL certificate and configure an SSL VPN using that
certificate.

Import the signed certificate into your FortiGate device

1. Unzip the file downloaded from the CA.
There should be two .CRT files: a CA certificate with bundle in the file name, and a local certificate.

2. Log in to your FortiGate unit and browse to System > Certificates.
3. Select Create New > Local Certificate to import the local certificate.

The status of the certificate will change from PENDING to OK.
4. Import the CA certificate by selecting Import > CA Certificate.

It will be listed in the CACertificates section of the certificates list. You can now configure SSL VPN using the
signed certificate.

Configure your FortiGate device to use the signed certificate

1. Log in to your FortiGate unit and browse to VPN > SSL-VPN Settings.
2. In the Connection Settings section, locate the Server Certificate field.
3. Select the new certificate from the drop-down menu.
4. Select Apply to configure SSL VPN to use the new certificate.

Implement post-authentication CSRF protection in SSL VPN web mode

This attribute can enable/disable verification of a referrer in the HTTP request header in order to prevent a Cross-
Site Request Forgery attack.

CLI Syntax

config vpn ssl settings
set check-referer [enable|disable]

end

DTLS support

The Datagram Transport Layer Security (DTLS) protocol is supported for SSL VPN connections. DTLS allows
datagram-based applications to communicate in a way that prevents eavesdropping, tampering, or message
forgery. It can also be used to improve upload/download throughput. It is similar to the Transport Layer Security
(TLS) protocol.

DTLS support can be enabled in the CLI as described below.
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CLI Syntax

config vpn ssl settings
set dtls-tunnel [enable | disable] (default: enabled)

end

Allow firewall address to be used in routing table for SSL VPN

If destination Named Address is set in Network > Static Routes and Address Range is set to
Automatically assign addresses is enabled in VPN > SSL-VPN Settings, SSL VPN should refresh the
routing table automatically.

To view the routes in the routing table, go toMonitor > Routing Monitor.

WAN link load balancing

You can set virtual-wan-link as the destination interface in a firewall policy (when SSL VPN is the source
interface) for WAN link load balancing. This allows logging into a FortiGate via SSL VPN for traffic inspection and
then have outbound traffic load balanced byWAN link load balancing.

CLI syntax

config firewall policy
edit <example>

set dstintf virtual-wan-link
end
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The remote client connects to the SSL VPN tunnel in various ways, depending on the VPN configuration.

l Tunnel mode establishes a connection to the remote protected network that any application can use. If the client
computer runs Microsoft Windows, they can download the tunnel mode client from the web portal.
If the client computer runs Linux or Mac OS X, the user needs to download the tunnel mode client application from
the Fortinet Support web site. See the Release Notes for your FortiOS firmware for the specific operating system
versions that are supported.

l The virtual desktop application creates a virtual desktop on a user's PC and monitors the data read/write activity of
the web browser running inside the virtual desktop. When the application starts, it presents a ‘virtual desktop’ to the
user. The user starts the web browser from within the virtual desktop and connects to the SSL VPN web portal. The
browser file/directory operation is redirected to a new location, and the data is encrypted before it is written to the
local disk. When the virtual desktop application exits normally, all the data written to the disk is removed. If the
session terminates abnormally (power loss, system failure, etc.), the data left behind is encrypted and unusable to
the user. The next time you start the virtual desktop, the encrypted data is removed.

The SSL VPN standalone client installer for Windows is no longer supported in FortiOS
5.4. Users should use the FortiClient installer with the "VPN Only" option instead.

FortiClient
Remote users can use the FortiClient software to initiate an SSL VPN tunnel to connect to the internal network.
FortiClient uses local port TCP 1024 to initiate an SSL encrypted connection to the FortiGate unit, on port TCP
443. When connecting using FortiClient, the FortiGate unit authenticates the FortiClient SSL VPN request based
on the user group options. The FortiGate unit establishes a tunnel with the client and assigns a virtual IP address
to the client PC. Once the tunnel has been established, the user can access the network behind the FortiGate
unit.

FortiClient software is available for download at www.forticlient.com and is available for Windows, Mac OS X,
Apple iOS, and Android.

Tunnel mode client configuration
The FortiClient SSL VPN tunnel client requires basic configuration by the remote user to connect to the SSL VPN
tunnel. When distributing the FortiClient software, provide the following information for the remote user to enter
once the client software has been started. Once entered, they can select Connect to begin an SSL VPN session.

Connection Name If you have pre-configured the connection settings, select the connection
from the list and then select Connect. Otherwise, enter the settings in the
fields below.

Remote Gateway Enter the IP address or FQDN of the FortiGate unit that hosts the SSL
VPN.

3054 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

http://www.forticlient.com/


The SSL VPN client

Username Enter your username.

Client Certificate

Use this field if the SSL VPN requires a certificate for authentication.

Select the required certificate from the drop-down list. The certificate must
be installed in the Internet Explorer certificate store.
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This chapter explains how to use and configure the web portal features. This chapter is written for end users as
well as administrators.

The following topics are included:

Connecting to the FortiGate unit
You can connect to the FortiGate unit using a web browser. The URL of the FortiGate interface may vary from
one installation to the next. If required, ask your FortiGate administrator for the URL of the FortiGate unit, and
obtain a user name and password. You can connect to the web portal using an Android phone, iPhone, or iPad.
The FortiGate unit will display the content of the portal to fit the device’s screen.

In addition, if you will be using a personal or group security (X.509) certificate to connect to the FortiGate unit,
your web browser may prompt you for the name of the certificate. Your FortiGate administrator can tell you which
certificate to select.

To log into the secure FortiGate HTTP gateway

1. Using the web browser on your computer, browse to the URL of the FortiGate unit (for example,
https://<FortiGate_IP_address>:443/remote/login). The FortiGate unit may offer you a self-signed
security certificate. If you are prompted to proceed, select Yes.
A second message may be displayed to inform you that the FortiGate certificate distinguished name differs from
the original request. This message is displayed because the FortiGate unit is attempting to redirect your web
browser connection. You can ignore the message.

2. When you are prompted for your user name and password:
l In the Name field, type your user name.
l In the Password field, type your password.

3. Select Login.
The FortiGate unit will redirect your web browser to the FortiGate SSL VPN web portal home page automatically.

Web portal overview
After logging in to the web portal, the remote user is presented with a web portal page similar to the following:
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Various widgets provide the web portal’s features:

l Session Information displays the elapsed time since login and the volume of HTTP and HTTPS traffic, both
inbound and outbound.

l Quick Connection enables you to connect to network resources without using or creating a bookmark.
l Download Forticlient provides access to the FortiClient tunnel application for various operating systems.
l Bookmarks provides links to network resources. You can use the administrator-defined bookmarks and you can

add your own bookmarks.

While using the web portal, you can select the Help button to get information to assist you in using the portal
features. This information displays in a separate browser window.

When you have finished using the web portal, select the Logout button in the top right corner of the portal
window.

After making any changes to the web portal configuration, be sure to select Apply.

Portal configuration
The SSL VPN web portal enables users to access network resources through a secure channel using a web
browser. Fortinet administrators can configure log in privileges for system users and which network resources are
available to the users.
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The portal configuration determines what the user sees when they log in to the portal. Both the system
administrator and the user have the ability to customize the SSL VPN portal.

There are three pre-defined default web portal configurations available:

l full-access: Includes all widgets available to the user - Session Information, Tunnel Mode options,
Connection Launcher, Remote Desktop, and Predefined Bookmarks.

l tunnel-access: IncludesSession Information and Tunnel Mode options.
l web-access: IncludesSession Information and Predefined Bookmarkswidgets.

You can also create your own web portal to meet your corporate requirements.

Portal page

Create New Creates a new web portal.

Edit Select a portal from the list to enable the Edit option, and modify the portal
configuration.

Delete Removes a portal configuration.

To remove multiple portals from the list, select the check box beside the
portal names, then select Delete.

Name The name of the web portal.

Ref. Displays the number of times the object is referenced in other
configurations on the FortiGate unit, such as security policies.

To view the location of the referenced object, select the number in Ref.
column.

To view more information about how the object is used, select one of:

View the list page for these objects – automatically redirects you to the
list page where the object is referenced at.

Edit this object – modifies settings within that particular setting that the
object is referenced with.

View the details for this object – similar to the log viewer table, contains
information about what settings are configured within that particular setting
that the object is referenced with.

Portal settings

Aweb portal defines SSL VPN user access to network resources. The portal configuration determines what SSL
VPN users see when they log in to the unit. Both the Fortinet administrator and the SSL VPN user have the ability
to customize the web portal settings. Portal settings are configured in VPN > SSL-VPN Portals.

The following settings are available, allow you to configure general and security console options for your web
portal.
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Portal Setting Description

Name The name for the portal.

Limit Users to One SSL-VPN
Connection at a Time

You can set the SSL VPN tunnel such that each user can only log
into the tunnel one time concurrently per user per login. That is,
once logged into the portal, they cannot go to another system and
log in with the same credentials again. This option is disabled by
default.

Tunnel Mode These settings determine how tunnel mode clients are assigned
IPv4 addresses.

Enable Split
Tunneling

Select so that the VPN carries only the traffic for the networks
behind the FortiGate unit. The user’s other traffic follows its normal
route.

If you enable split tunneling, you are required to set the Routing
Address, which is the address that your corporate network is
using. Traffic intended for the Routing Address will not be split
from the tunnel.

Source IP Pools Select an IP Pool for users to acquire an IP address when
connecting to the portal. There is always a default pool available if
you do not create your own.

Tunnel Mode Client
Options

These options affect how the FortiClient application behaves when
connected to the FortiGate VPN tunnel. When enabled, a check
box for the corresponding option appears on the VPN login screen
in FortiClient, and is not enabled by default.

l Allow client to save password - When enabled, if the user
selects this option, their password is stored on the user’s
computer and will automatically populate each time they connect
to the VPN.

l Allow client to connect automatically - When enabled, if the
user selects this option, when the FortiClient application is
launched, for example after a reboot or system startup,
FortiClient will automatically attempt to connect to the VPN
tunnel.

l Allow client to keep connections alive - When enabled, if the
user selects this option, the FortiClient should try to reconnect
once it detects the VPN connection is down unexpectedly (not
manually disconnected by user).

Enable Web Mode Select to enable web mode access.

Portal Message This is a text header that appears on the top of the web portal.
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Portal Setting Description

Theme Select a color styling specifically for the web portal.

Show Session Information
The Show Session Information widget displays the login name
of the user, the amount of time the user has been logged in and
the inbound and outbound traffic statistics.

Show Connection Launcher Displays the Connection Launcher widget in the web portal.

Show Login History Select to include user login history on the web portal.

User Bookmarks Enable to allow users to add their own bookmarks in the web
portal.

Predefined Bookmarks

Select to include bookmarks on the web portal. Bookmarks are
used as links to internal network resources. When a bookmark is
selected from a bookmark list, a pop-up window appears with the
web page. Telnet, VNC, and RDP require a browser plugin. FTP
and Samba replace the bookmarks page with an HTML file-
browser.

Predefined Bookmarks

Bookmarks are used as links to specific resources on the network. When a bookmark is selected from a bookmark
list, a pop-up window appears with the requested web page. Telnet, RDP, and VNC pop up a window that
requires a browser plug-in. FTP and Samba replace the bookmarks page with an HTML file-browser.

Note that the RDP/VNC web portals are not supported for the following platforms:

Platform Model

FortiGate 80D, 92D, 200D, 200D-POE, 240D, 240D-POE, 600C, 800C, 1000C,
3240C, 3600C, and 5001C

FortiGate-Rugged 90D

FortiWiFi 92D

Aweb bookmark can include login credentials to automatically log the SSL VPN user into the web site. When the
administrator configures bookmarks, the web site credentials must be the same as the user’s SSL VPN
credentials. Users configuring their own bookmarks can specify alternative credentials for the web site.

Applications available in the web portal

Depending on the web portal configuration and user group settings, one or more of the following server
applications are available to you through Predefined Bookmarks, as well as theQuick Connection widget:

l Citrix makes use of SOCKS so that the Citrix client can connect to the SSL VPN port forward module to provide the
connection.

l FTP (File Transfer Protocol) enables you to transfer files between your computer and a remote host.
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l HTTP/HTTPS accesses web pages.
l Port Forward provides the middle ground between web mode and tunnel mode. When the SSL VPN receives data

from a client application, the data is encrypted and sent to the FortiGate unit, which then forwards the traffic to the
application server.

l RDP (Remote Desktop Protocol), similar to VNC, enables you to remotely control a computer running Microsoft
Terminal Services.

l SMB/CIFS implements the Server Message Block (SMB) protocol to support file sharing between your computer
and a remote server host.

l SSH (Secure Shell) enables you to exchange data between two computers using a secure channel.
l TELNET (Teletype Network emulation) enables you to use your computer as a virtual text-only terminal to log in to a

remote host.
l VNC (Virtual Network Computing) enables you to remotely control another computer, for example, accessing your

work computer from your home computer.

Some server applications may prompt you for a user name and password. You must have a user account created
by the server administrator so that you can log in.

Windows file sharing through SMB/CIFS is supported through shared directories.

Group-based SSL VPN bookmarks

The administrator can add bookmarks for groups of users. SSL VPN will only output the matched group-name
entry to the client. This can only be done via the CLI.

To add group-based SSL VPN bookmarks - CLI:

config vpn ssl web portal
edit "portal-name"

set user-group-bookmark enable*/disable
next

end
config vpn ssl web user-group-bookmark

edit "group-name"
config bookmark

edit "bookmark1"
....
next

end
next

end

Using the Bookmarks widget
The Bookmarks widget shows both administrator-configured and user-configured bookmarks. Administrator
bookmarks cannot be altered but you can add, edit or delete user bookmarks.

The FortiGate unit forwards client requests to servers on the Internet or internal network. To use the web-portal
applications, you add the URL, IP address, or name of the server application to the My Bookmarks list. For more
information, see Adding bookmarks on page 3062.
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If you want to access a web server or telnet server without first adding a bookmark to
the My Bookmarks list, use the Connection Tool instead. For more information, see
Using the Bookmarks widget on page 3061.

Adding bookmarks

You can add frequently used connections as bookmarks. Afterward, select any hyperlink from the Bookmarks list
to initiate a session.

To add a bookmark
1. In the web portal, select New Bookmark.
2. Enter the following information:

Name Enter the name to display in the Bookmarks list.

Type Select the abbreviated name of the server application or network service
from the drop-down list.

Location Enter the IP address or FQDN of the server application or network service.

For RDP connections, you can append some parameters to control screen
size and keyboard layout. See Using the Bookmarks widget on page 3061.

Description Optionally enter a short description. The description displays when you
pause the mouse pointer over the hyperlink.

SSO Single Sign On (SSO) is available for HTTP/HTTPS bookmarks only.

Disabled— This is not an SSO bookmark.

Automatic— Use your SSL VPN credentials or an alternate set. See the
SSO Credentials field.

Static— Supply credentials and other required information (such as an
account number) to a web site that uses an HTML form for authentication.
You provide a list of the form field names and the values to enter into them.
This method does not work for sites that use HTTP authentication, in which
the browser opens a pop-up dialog box requesting credentials.

SSO fields

SSO Credentials SSL VPN Login— Use your SSL VPN login credentials.

Alternative— EnterUsername and Password below.

Username Alternative username. Available if SSO Credentials isAlternative.

Password Alternative password. Available if SSO Credentials isAlternative.

Static SSO fields These fields are available if SSO is Static.
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Field Name Enter the field name, as it appears in the HTML form.

Value Enter the field value.

To use the values from SSO Credentials, enter %passwd% for password
or %username% for username.

Add Add another Field Name / Value pair.

3. Select OK and then select Done.

Group-based SSL VPN bookmarks

This CLI-only feature allows administrators to add bookmarks for groups of users. SSL VPN will only output the
matched group-name entry to the client.

Syntax:

config vpn ssl web portal
edit "portal-name"

set user-group-bookmark enable*/disable
next

end
conf vpn ssl web user-group-bookmark

edit "group-name"
conf bookmark

edit "bookmark1"
....
next

end
next

end

Group-based SSL VPN bookmarks

This CLI-only feature allows administrators to add bookmarks for groups of users. SSL VPN will only output the
matched group-name entry to the client.

Syntax:

config vpn ssl web portal
edit <portal-name>

set user-group-bookmark [enable | disable]
next

end
config vpn ssl web user-group-bookmark

edit <group-name>
config bookmark

edit <bookmark1>
....
next

end
next

end
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Using the Quick Connection Tool
TheQuick Connection Tool widget enables a user to connect to a resource when it isn’t a predefined
bookmark.

You can connect to any type of server without adding a bookmark to the Bookmarks list. The fields in theQuick
Connection Tool enable you to specify the type of server and the URL or IP address of the host computer.

See the following procedures:

l To connect to a web server on page 3064
l To ping a host or server behind the FortiGate unit on page 3064
l To start a Telnet session on page 3065
l To start an FTP session on page 3065
l To start an SMB/CIFS session on page 3065
l To start an SSH session on page 3066
l To start an RDP session on page 3066
l To start a VNC session on page 3066

Except for ping, these services require that you have an account on the server to
which you connect.

When you useQuick Connection Tool, the FortiGate unit may offer you its self-
signed security certificate. Select Yes to proceed. A second message may be
displayed to inform you of a host name mismatch. This message is displayed because
the FortiGate unit is attempting to redirect your web browser connection. Select Yes
to proceed.

To connect to a web server

1. In Type, select HTTP/HTTPS.
2. In the Host field, type the URL of the web server.

For example: http://www.mywebexample.com or https://172.20.120.101
3. Select Launch.
4. To end the session, close the browser window.

To ping a host or server behind the FortiGate unit

1. In Type, select Ping.
2. In the Host field, enter the IP address of the host or server that you want to reach.

For example: 10.11.101.22
3. Select Launch.

A message stating whether the IP address can be reached or not is displayed.
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To start a Telnet session

1. In Type, select Telnet.
2. In the Host field, type the IP address of the telnet host.

For example: 10.11.101.12
3. Select Launch.

A Telnet window opens.
4. Select Connect.
5. A telnet session starts and you are prompted to log in to the remote host.

After you log in, you may enter any series of valid telnet commands at the system prompt.
6. To end the session, select Disconnect (or type exit) and then close the TELNET connection window.

To start an FTP session

1. In Type, select FTP.
2. In the Host field, type the IP address of the FTP server.

For example: 10.11.101.12
3. Select Launch.

A login window opens.
4. Enter your user name and password and then select Login.

You must have a user account on the remote host to log in.
5. Manipulate the files in any of the following ways:

l To download a file, select the file link in the Name column.
l To access a subdirectory (Type is Folder), select the link in the Name column.
l To create a subdirectory in the current directory, select New directory.
l To delete a file or subdirectory from the current directory, select itsDelete icon.
l To rename a file in the current directory, select itsRename icon.
l To upload a file to the current directory from your client computer, select Upload.
l When the current directory is a subdirectory, you can select Up to access the parent directory.

6. To end the FTP session, select Logout.

To start an SMB/CIFS session

1. In Type, select SMB/CIFS.
2. In the Host field, type the IP address of the SMB or CIFS server.

For example: 10.11.101.12
3. Select Launch.
4. Enter your user name and password and then select Login.

You must have a user account on the remote host to log in.
5. Manipulate the files in any of the following ways:

l To download a file, select the file link in the Name column.
l To access a subdirectory (Type is Folder), select the file link in the Name column.
l To create a subdirectory in the current directory, select New Directory.
l To delete a file or subdirectory from the current directory, select itsDelete icon.
l To rename a file, select itsRename icon.
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l To upload a file from your client computer to the current directory, select Upload.
l When the current directory is a subdirectory, you can select Up to access the parent directory.

6. To end the SMB/CIFS session, select Logout and then close the SMB/CIFS window.

To start an SSH session

1. In Type, select SSH.
2. In the Host field, type the IP address of the SSH host.

For example: 10.11.101.12
3. Select Launch.

A login window opens.
4. Select Connect.

A SSH session starts and you are prompted to log in to the remote host. You must have a user account to log in.
After you log in, you may enter any series of valid commands at the system prompt.

5. To end the session, select Disconnect (or type exit) and then close the SSH connection window.

To start an RDP session

1. In Type, select RDP.
2. In the Host field, type the IP address of the RDP host.

For example: 10.11.101.12
3. To log in to the remote host, type your user name and password. You must have a user account on the remote

host to log in. Note that the user name should be entered in User Principal Name (UPN) format.
4. Select Launch.

A login window opens.
5. Select Login.

If you need to send Ctrl-Alt-Delete in your session, use Ctrl-Alt-End.
6. To end the RDP session, Log out of Windows or select Cancel from the Logon window.

SomeWindows servers require a specific Security to be set for RDP sessions, such as
Network Level Authentication (NLA) or Transport Layer Security (TLS), not the
standard RDP encryption security. For example, Windows 10 requires the use of TLS.

To start a VNC session

1. In Type, select VNC.
2. In the Host field, type the IP address of the VNC host.

For example: 10.11.101.12
3. Select Launch.

A login window opens.
4. Type your user name and password when prompted to log in to the remote host.

You must have a user account on the remote host to log in.
5. Select OK.

If you need to send Ctrl-Alt-Delete in your session, press F8, then select Send Ctrl-Alt-Delete from the pop-up
menu.

6. To end the VNC session, close the VNC window.

Note that the RDP/VNC web portals are not supported for the following platforms:
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Platform Model

FortiGate 80D, 92D, 200D, 200D-POE, 240D, 240D-POE, 600C, 800C, 1000C,
3240C, 3600C, and 5001C

FortiGate-Rugged 90D

FortiWiFi 92D

Using FortiClient
Remote users can use FortiClient Endpoint Security to initiate an SSL VPN tunnel to connect to the internal
network. FortiClient uses local port TCP 1024 to initiate an SSL encrypted connection to the FortiGate unit, on
port TCP 10443. When connecting using FortiClient, the FortiGate unit authenticates the FortiClient SSL VPN
request based on the user group options. the FortiGate unit establishes a tunnel with the client and assigns a
virtual IP address to the client PC. Once the tunnel has been established, the user can access the network behind
the FortiGate unit.

For information on configuring the FortiGate unit for SSL VPN connectivity, see Basic configuration on page
3024. For details on configuring FortiClient for SSL VPN connections, see the FortiClient documentation.
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The examples in this chapter demonstrate the basic configurations needed for common connections to the SSL
VPN tunnel and portals, applying the steps outlined in Basic configuration on page 3024.

The following examples are included:

Secure Internet browsing
This example sets up an SSL VPN tunnel that provides remote users the ability to access the Internet while
traveling, and ensures that they are not subject to malware and other dangers, by using the corporate firewall to
filter all of their Internet traffic. Essentially, the remote user will connect to the corporate FortiGate unit to surf the
Internet.

Using SSL VPN and FortiClient SSL VPN software, you create a means to use the corporate FortiGate to browse
the Internet safely.

Creating an SSL VPN IP pool and SSL VPN web portal

1. Go to VPN > SSL-VPN Portals and select tunnel-access.
2. Disable Split Tunneling.
3. For Source IP Pools select SSLVPN_TUNNEL_ADDR1.
4. Select OK.

Creating the SSL VPN user and user group

1. Create the SSL VPN user and add the user to a user group configured for SSL VPN use.
2. Go to User & Device > User Definition and select Create New to add the user:

User Name twhite

Password password

3. Select OK.
4. Go to User & Device > User Groups and select Create New to add twhite to a group called SSL VPN:
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Name SSL VPN

Type Firewall

5. Move twhite to theMembers list.
6. Select OK.

Creating a static route for the remote SSL VPN user

Create a static route to direct traffic destined for tunnel users to the SSL VPN tunnel.

1. Go to Network > Static Routes and select Create New to add the static route.

Destination IP/Mask 10.212.134.0/255.255.255.0

Device ssl.root

The Destination IP/Mask matches the network address of the remote SSL VPN user.

2. Select OK.

Creating security policies

Create an SSL VPN security policy with SSL VPN user authentication to allow SSL VPN traffic to enter the
FortiGate unit.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Add an SSL VPN security policy as below, and clickOK.

Incoming Interface ssl.root

Outgoing Interface internal

Source Address all

Source User Group SSL VPN

Destination all

3. Select OK.

Configuring authentication rules

1. Go to VPN > SSL-VPN Settings and select Create New underAuthentication/Portal Mapping.
2. Add an authentication rule for the remote user:

Users/Groups Tunnel

Portal tunnel-access
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3. Select OK and Apply.

Results

Using the FortiClient SSLVPN application, access the VPN using the address
https://172.20.120.136:443/ and log in as twhite. Once connected, you can browse the Internet.

From the FortiGate web-based manager, go toMonitor > SSL-VPN Monitor to view the list of users connected
using SSL VPN. The Subsession entry indicates the split tunnel which redirects to the Internet.

Split Tunnel
In this configuration, remote users are able to securely access the head office internal network through the head
office firewall, yet browse the Internet without going through the head office FortiGate. Split tunneling is enabled
by default for SSL VPN on FortiGate units.

The solution below describes how to configure FortiGate SSL VPN split tunneling using the FortiClient SSL VPN
software, available from the Fortinet Support site.

Without split tunneling, all communication from remote SSL VPN users to the head office internal network and to
the Internet uses an SSL VPN tunnel between the user’s PC and the head office FortiGate unit. Connections to
the Internet are routed back out the head office FortiGate unit to the Internet. Replies come back into the head
office FortiGate unit before being routed back through the SSL VPN tunnel to the remote user.

In short, enabling split tunneling protects the head office from potentially harmful access and external threats that
may occur as a result of the end user's indiscretion while browsing the Internet. By contrast, disabling split
tunneling protects the end user by forcing all their Internet traffic to pass through the FortiGate firewall.

Creating a firewall address for the head office server

1. Go to Policy & Objects > Addresses and select Create New and add the head office server address:

Category Address

Name Head office server

Type Subnet

Subnet / IP Range 192.168.1.12

Interface Internal

2. Select OK.

Creating an SSL VPN IP pool and SSL VPN web portal

1. Go to VPN > SSL-VPN Portals and select tunnel-access.
2. Enter the following:

Name Connect to head office server

Enable Tunnel Mode Enable
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Enable Split Tunneling Enable

Routing Address Internal

Source IP Pools SSLVPN_TUNNEL_ADDR1

3. Select OK.

Creating the SSL VPN user and user group

Create the SSL VPN user and add the user to a user group.

1. Go to User & Device > User Definition, select Create New and add the user:

User Name twhite

Password password

2. Select OK.
3. Go to User & Device > User Groups and select Create New to add the new user to the SSL VPN user group:

Name Tunnel

Type Firewall

4. Move twhite to theMembers list.
5. Select OK.

Creating a static route for the remote SSL VPN user

Create a static route to direct traffic destined for tunnel users to the SSL VPN tunnel.

1. Go to Network > Static Routes and select Create New

Destination IP/Mask 10.212.134.0/255.255.255.0

Device ssl.root

2. Select OK.

Creating security policies

Create an SSL VPN security policy with SSL VPN user authentication to allow SSL VPN traffic to enter the
FortiGate unit. Create a normal security policy from ssl.root to wan1 to allow SSL VPN traffic to connect to the
Internet.

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Complete the following:

Incoming Interface ssl.root
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Source Address all

Source User(s) Tunnel

Outgoing Interface internal

Destination Address Head office server

3. Select OK.
4. Add a security policy that allows remote SSL VPN users to connect to the Internet.
5. Select Create New.
6. Complete the following and select OK:

Incoming Interface ssl.root

Source Address all

Source User(s) Tunnel

Outgoing Interface wan1

Destination Address all

Schedule always

Service ALL

Action ACCEPT

Configuring authentication rules

1. Go to VPN > SSL-VPN Settings and select Create New underAuthentication/Portal Mapping.
2. Add an authentication rule for the remote user:

Users/Groups Tunnel

Portal tunnel-access

3. Select OK and Apply.

Results

Using the FortiClient SSL VPN application on the remote PC, connect to the VPN using the address
https://172.20.120.136:443/ and log in with the twhite user account. Once connected, you can
connect to the head office server or browse to web sites on the Internet.

From the web-based manager, go toMonitor > SSL-VPN Monitor to view the list of users connected using
SSL VPN. The Subsession entry indicates the split tunnel which redirects SSL VPN sessions to the Internet.
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Multiple user groups with different access permissions
You might need to provide access to several user groups with different access permissions. Consider the
following example topology in which users on the Internet have controlled access to servers and workstations on
private networks behind a FortiGate unit.

In this example configuration, there are two users:

l User1 can access the servers on Subnet_1.
l User2 can access the workstation PCs on Subnet_2.

You could easily add more users to either user group to provide them access to the user group’s assigned web
portal.

General configuration steps

1. Create firewall addresses for:
l The destination networks.
l Two non-overlapping tunnel IP address ranges that the FortiGate unit will assign to tunnel clients in the two

user groups.

2. Create two web portals.
3. Create two user accounts, User1 and User2.
4. Create two user groups. For each group, add a user as a member and select a web portal. In this example, User1

will belong to Group1, which will be assigned to Portal1 (similar configuration for User2).
5. Create security policies:

l Two SSL VPN security policies, one to each destination.
l Two tunnel-mode policies to allow each group of users to reach its permitted destination network.

6. Create the static route to direct packets for the users to the tunnel.

Creating the firewall addresses

Security policies do not accept direct entry of IP addresses and address ranges. You must define firewall
addresses in advance.

Creating the destination addresses

SSL VPN users in this example can access either Subnet_1 or Subnet_2.

To define destination addresses - web-based manager:

1. Go to Policy & Objects > Addresses.
2. Select Create New, enter the following information, and select OK:

Name Subnet_1

Type Subnet

Subnet/IP Range 10.11.101.0/24

Interface port2
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3. Select Create New, enter the following information, and select OK:

Name Subnet_2

Type Subnet

Subnet/IP Range 10.11.201.0/24

Interface port3

Creating the tunnel client range addresses

To accommodate the two groups of users, split an otherwise unused subnet into two ranges. The tunnel client
addresses must not conflict with each other or with other addresses.

To define tunnel client addresses - web-based manager:

1. Go to Policy & Objects > Addresses.
2. Select Create New, enter the following information, and select OK:

Name Tunnel_group1

Type IP Range

Subnet/IP Range 10.11.254.1-10.11.254.50

Interface Any

3. Select Create New, enter the following information, and select OK.

Name Tunnel_group2

Type IP Range

Subnet/IP Range 10.11.254.51-10.11.254.100

Interface Any

Creating the web portals

To accommodate two different sets of access permissions, you need to create two web portals, portal1 and
portal2, for example. Later, you will create two SSL VPN user groups, one to assign to portal1 and the other to
assign to portal2.

To create the portal1 web portal:

1. Go to VPN > SSL-VPN Portals and select Create New.
2. Enter portal1 in the Name field.
3. In Source IP Pools, select Tunnel_ group1.
4. Select OK.
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To create the portal2 web portal:

1. Go to VPN > SSL-VPN Portals and select Create New.
2. Enter portal2 in the Name field and select OK.
3. In IP Pools, select Tunnel_ group2
4. Select OK.
Later, you can configure these portals with bookmarks and enable connection tool capabilities for the
convenience of your users.

Creating the user accounts and user groups

After enabling SSL VPN and creating the web portals that you need, you need to create the user accounts and
then the user groups that require SSL VPN access.

Go to User & Device > User Definition and create user1 and user2 with password authentication. After you
create the users, create the SSL VPN user groups.

To create the user groups - web-based manager:

1. Go to User & Device > User Groups.
2. Select Create New and enter the following information:

Name Group1

Type Firewall

3. From the Available list, select User1 and move it to theMembers list by selecting the right arrow button.
4. Select OK.
5. Repeat steps 2 through 4 to create Group2, assigned to Portal2, with User2 as its only member.

Creating the security policies

You need to define security policies to permit your SSL VPN clients, web-mode or tunnel-mode, to connect to the
protected networks behind the FortiGate unit. Before you create the security policies, you must define the source
and destination addresses to include in the policy. See Creating the firewall addresses on page 3073.

Two types of security policy are required:

l An SSL VPN policy enables clients to authenticate and permits a web-mode connection to the destination network.
In this example, there are two destination networks, so there will be two SSL VPN policies. The authentication
ensures that only authorized users can access the destination network.

l A tunnel-mode policy is a regular ACCEPT security policy that enables traffic to flow between the SSL VPN tunnel
interface and the protected network. Tunnel-mode policies are required if you want to provide tunnel-mode
connections for your clients. In this example, there are two destination networks, so there will be two tunnel-mode
policies.

To create the SSL VPN security policies - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information and clickOK:
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Incoming Interface ssl.root (sslvpn tunnel interface)

Source Address All

Source User(s) Group1

Outgoing Interface port2

Destination Address Subnet_1

Service All

3. Select Create New.
4. Enter the following information:

Incoming Interface ssl.root (sslvpn tunnel interface)

Source Address All

Source User(s) Group2

Outgoing Interface port3

Destination Address Subnet_2

Service All

5. ClickOK.

Configuring authentication rules

1. Go to VPN > SSL-VPN Settings and select Create New underAuthentication/Portal Mapping.
2. Add an authentication rule for the first remote group:

Users/Groups Group1

Portal Portal1

3. Select OK and Apply.
4. Select Create New and add an authentication rule for the second remote group:

Users/Groups Group2

Portal Portal2

5. Select OK and Apply.

To create the tunnel-mode security policies - web-based manager:

1. Go to Policy & Objects > IPv4 Policy and select Create New.
2. Enter the following information, and select OK:
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Incoming Interface ssl.root (sslvpn tunnel interface)

Source Address Tunnel_group1

Source User(s) Group1

Outgoing Interface port2

Destination Address Subnet_1

Service All

Action ACCEPT

Enable NAT Enable

3. Select Create New.
4. Enter the following information, and select OK:

Incoming Interface ssl.root (sslvpn tunnel interface)

Source Address Tunnel_group2

Source User(s) Group2

Outgoing Interface port3

Destination Address Subnet_2

Service All

Action ACCEPT

Enable NAT Enable

Create the static route to tunnel mode clients

Reply packets destined for tunnel mode clients must pass through the SSL VPN tunnel. You need to define a
static route to allow this.

To add a route to SSL VPN tunnel mode clients - web-based manager:

1. Go to Network > Static Routes and select Create New.
2. Enter the following information and select OK.

Destination IP/Mask 10.11.254.0/24

This IP address range covers both ranges that you assigned to SSL VPN
tunnel-mode users. See Creating the tunnel client range addresses on
page 3074.

Device Select the SSL VPN virtual interface, ssl.root for example.
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In this example, the IP Pools field on the VPN > SSL-VPN Settings page is not
used because each web portal specifies its own tunnel IP address range.

Client device certificate authentication with multiple groups
In the following example, we require clients connecting to a FortiGate SSL VPN to have a device certificate
installed on their machine in order to authenticate to the VPN.

Employees (in a specific OU in AD) will be required to have a device certificate to connect, while vendors (in a
separate OU in AD) will not be required to have a device certificate.

This can only be performed in the CLI console.

The Authentication-rule option is only available in theCLI as an advanced setting to
achieve your requirements. It is not available on the GUI. So in VPN > SSL-VPN
Settings, do not enable Require Client Certificate, but selectively enable
client-cert in each authentication-rule based on the requirements through CLI
instead.

Configuring SSL VPN shared settings and authentication rules - CLI:

The following example assumes that remote LDAP users/groups have been pre-configured.

config vpn ssl settings
set servercert "Fortinet_Factory"
set tunnel-ip-pools "SSLVPN_TUNNEL_ADDR1"
set port 443
set source-interface "wan1"
set source-address "all"
set default-portal "full-access"

config authentication-rule
edit 1

set source-interface "wan1
set source-address "all"
set groups "Employees"
set portal "full-access"
set client-cert enable

next
edit 2

set source-interface "wan1"
set source-address "all"
set groups "Vendors"
set portal "full-access"
set client-cert disable <-- Set by default and will not be displayed.

next
end

end

Configure the remainder of the SSL VPN tunnel as normal (creating a firewall policy allowing SSL VPN access to
the internal network, including the VPN groups, necessary security profiles, etc.).

If configured correctly, only the 'Employees' group should require a client certificate to authenticate to the VPN.
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This section contains tips to help you with some common challenges of SSL VPNs.

l Enter the following to display debug messages for SSL VPN:

diagnose debug application sslvpn -1

This command enables debugging of SSL VPN with a debug level of -1. The -1 debug level produces detailed
results.

l Enter the following command to verify the debug configuration:

diagnose debug info
debug output: disable
console timestamp: disable
console no user log message: disable
sslvpn debug level: -1 (0xffffffff)
CLI debug level: 3

This output verifies that SSL VPN debugging is enabled with a debug level of -1, and shows what filters are in
place. The output above indicates that debug output is disabled, so debug messages are not displayed. The
output also indicates that debugging has not been enabled for any software systems.

l Enter the following to enable displaying debug messages:

diagnose debug enable

To view the debug messages, log into the SSL VPN portal. The CLI displays debug output similar to the
following:

FGT60C3G10002814 # [282:root]SSL state:before/accept initialization (172.20.120.12)
[282:root]SSL state:SSLv3 read client hello A (172.20.120.12)
[282:root]SSL state:SSLv3 write server hello A (172.20.120.12)
[282:root]SSL state:SSLv3 write change cipher spec A (172.20.120.12)
[282:root]SSL state:SSLv3 write finished B (172.20.120.12)
[282:root]SSL state:SSLv3 flush data (172.20.120.12)
[282:root]SSL state:SSLv3 read finished A:system lib(172.20.120.12)
[282:root]SSL state:SSLv3 read finished A (172.20.120.12)
[282:root]SSL state:SSL negotiation finished successfully (172.20.120.12)
[282:root]SSL established: DHE-RSA-AES256-SHA SSLv3 Kx=DH Au=RSA Enc=AES(256) Mac=SHA1

l Enter the following to stop displaying debug messages:

diagnose debug disable

The following is a list of potential issues. The suggestions below are not exhaustive, and may not reflect your
network topology.

There is no response from the SSL VPN URL.

l Go to VPN > SSL-VPN Settings and check the SSL VPN port assignment. Also, verify that the SSL VPN policy is
configured correctly.

l Check the URL you are attempting to connect to. It should follow this pattern:

https://<FortiGate IP>:<Port>/remote/login
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l Ensure that you are using the correct port number in the URL.

FortiClient cannot connect.

Read the Release Notes to ensure that the version of FortiClient you are using is compatible with your version of
FortiOS.

Tunnel-mode connection shuts down after a few seconds.

This issue can occur when there are multiple interfaces connected to the Internet (for example, a dual WAN).
Upgrade to the latest firmware then use the following CLI command:

config vpn ssl settings
set route-source-interface enable

end

When you attempt to connect using FortiClient or in Web mode, you are returned to the login page, or
you receive the following error message: “Unable to logon to the server. Your user name or password
may not be configured properly for this connection. (-12).”

l Ensure that cookies are enabled in your browser.
l If you are using a remote authentication server, ensure that the FortiGate is able to communicate with it.
l Access to the web portal or tunnel will fail if Internet Explorer has the privacy Internet Options set to High. If set to

High, Internet Explorer will block cookies that do not have a compact privacy policy, and that use personally
identifiable information without your explicit consent.

You receive an error message stating: "Destination address of Split Tunneling policy is invalid."

The SSL VPN security policy uses the ALL address as its destination. Change the address to that of the
protected network instead.

The tunnel connects but there is no communication.

Go to Network > Static Routes and ensure that there is a static route to direct packets destined for the tunnel
users to the SSL VPN interface.

You can connect remotely to the VPN tunnel but are unable to access the network resources.

Go to Policy & Objects > IPv4 Policy and examine the policy allowing VPN access to the local network. If the
destination address is set to all, create a firewall address for the internal network. Change the destination address
and attempt to connect remotely again.

Users are unable to download the SSL VPN plugin.

Go to VPN > SSL-VPN Portals to make sure that the option to Limit Users to One SSL-VPN Connection
at a Time is disabled. This allows users to connect to the resources on the portal page while also connecting to
the VPN through FortiClient.

Users are being assigned to the wrong IP range.

Ensure that the same IP Pool is used in VPN Portal and VPN Settings to avoid conflicts. If there is a conflict, the
portal settings will be used.
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Flow-based (vdom) AntiVirus profiles in SSL VPN web mode limitation

In flow mode vdom, SSL VPN web mode doesn't block antivirus even when av-profile is set (however,
SSL VPN tunnel mode AV profile does work).

Sending tunnel statistics to FortiAnalyzer

By default, logged events include tunnel-up and tunnel-down status events. Other events, by default, will appear
in the FortiAnalyzer report as "No Data Available". More accurate results require logs with action=tunnel-
stats, which is used in generating reports on the FortiAnalyzer (rather than the tunnel-up and tunnel-down
event logs). The FortiGate does not, by default, send tunnel-stats information.

To allow VPN tunnel-stats to be sent to FortiAnalyzer, configure the FortiGate unit as follows using the CLI:

config system settings
set vpn-stats-log ipsec ssl
set vpn-stats-period 300

end

HTTP header information

The X-Content-Type-Options header is added to internal pages of SSL VPN to comport with PCI-DSS
compatibility. Strict-Transport-Security is added to the HTTP header for the same reason.
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System administration

Welcome and thank you for selecting Fortinet products for your network protection.

This guide explains how to get started with a FortiGate unit, as well as examining basic configuration tasks, best
practices, and more advanced configuration options.

How this guide is organized
This guide contains the following sections:

What's New in FortiOS 5.6 informs you about new system features in FortiOS 5.6.

Administrators describes the tasks that can be done to add and secure administrative access to a FortiGate.

Central management describes how to configure the FortiGate unit to use FortiManager as a method of
maintaining the device and other features that FortiManager has to facilitate the administration of multiple
devices.

Monitoring discusses the various methods of monitoring both the FortiGate unit and the network traffic through a
range of different tools available within FortiOS.

Replacement messages explains how to view and customize various replacement messages on the FortiGate.

Administration for schools shares basic practices administrators in school systems can employ to meet the
challenges of maintaining a network and access to the Internet

PPTP and L2TP contains information on configuring PPTP and L2TP VPNs as well as PPTP passthrough.

Session helpers explains how to use session helpers to analyze the data in the packet bodies of some protocols
and adjust the firewall to allow those protocols to send packets through the firewall.

Advanced concepts describes more involved administrative topics to enhance network security and traffic
efficiency.
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This section describes new system administration features added to FortiOS 5.6.3, 5.6.1, and 5.6.0.

FortiOS 5.6.3
The following new features were added to FortiOS 5.6.3.

Disallow use of default/empty password for local admins (421579) (434075) (448821) (449795)

When logging in using a local admin with the default or empty password, a warning prompt will appear upon
login. Admins will be logged out if they have no permissions.

BFD echo mode support when in Transparent mode (enable/disable blocking land attacks)
(441740)

Support has been added allowing you to enable or disable blocking land attacks.

This option is disabled by default. Since its a system settings option you can enable or disable blocking land
attacks for individual VDOMs if your FortiGate is operating with multiple VDOMs.

Another reason to enable this feature would be if your FortiGate is blocking BFD echo packets that should be
allowed to pass through the FortiGate. For example, a FortiGate operating in Transparent mode between two
routers with a policy that allows all traffic may block BFD echo communication between the routers if blocking
land attacks is disabled.

Enabling blocking land attacks allows BFD echo packets to pass through the FortiGate. Use the following
command to block land attacks and allow BFD echo packets.

Syntax

config system settings
set block-land-attack enable

end

FortiOS 5.6.1

Use self-sign as default GUI certificate if BIOS cert is using SHA-1 (403152)

For increased security, SHA-1 certificate has been replaced by self-sign certificate as the default GUI certificate,
if the BIOS certificate is using SHA-1.

Administrator timeout override per access profile (413543)

The GUI is often used for central monitoring. To do this requires the inactivity timeout to be increased, to avoid
an admin having to constantly log in over again. This new feature allows the admintimeout value, under
config system accprofile, to be overridden per access profile.

Note that this can be achieved on a per-profile basis, to avoid the option from being unintentionally set globally.
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CLI Syntax - Configure admin timeout

config system accprofile
edit <name>

set admintimeout-override {enable | disable}
set admintimeout <0-480> - (default = 10, 0 = unlimited)

next
end

New execute script command (423159)

A new execute command has been introduced to merge arbitrary configlets into the running configuration from
script. The command's authentication can be carried out using either username and password or with a
certificate. This command supports FTP/TFTP and SCP.

An important benefit of this feature is that if the configuration in the script fails (i.e. a syntax error), the system will
revert back to running configurations without interrupting the network.

CLI Syntax - Load script from FTP/TFTP/SCP server to firewall

execute restore scripts <ftp | tftp |
scp> <dir / filename in server> <server ip> <username> <password>

FortiOS 5.6

Remove CLI commands from 1-CPU platforms (405321)

Two CLI commands that set CPU affinity have been removed from 1-CPU platforms since they do not have any
impact on these platforms. The commands are config system global > set miglog-affinity and
config system global > set av-affinity <string>.

New SNMP trap for bypass events (307329)

When bypass mode is enabled or disabled on FortiGate units that are equipped with bypass interfaces and
support AMCmodules, a new SNMP trap is generated and logs bypass events.

Implement SNMP support for NAT Session monitoring which includes new SNMP OIDs
(383661)

FortiOS 5.6 implements a new feature providing SNMP support for NAT session monitoring. The resulting new
SNMP object identifier (OID) is:

FORTINET-FORTIGATE-
MIB:fortinet.fnFortiGateMib.fgFirewall.fgFwIppools.fgFwIppTables.fgFwIppStatsTable.fgFwIppStatsEntry
1.3.6.1.4.1.12356.101.5.3.2.1.1

Additionally, there are eight new items:

.fgFwIppStatsName .1

.fgFwIppStatsType .2

.fgFwIppStatsStartIp .3

3084 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 28 - System Administration What's New in FortiOS 5.6

.fgFwIppStatsEndIp .4

.fgFwIppStatsTotalSessions .5

.fgFwIppStatsTcpSessions .6

.fgFwIppStatsUdpSessions .7

.fgFwIppStatsOtherSessions .8

New extended database version OIDs for AV and IPS (402162)

New extended database version OIDs ensure accurate display of the AntiVirus and IPS databases in use when
you go to System > FortiGuard.

Administrator password encryption hash upgraded from SHA1 to SHA256 (391576)

The encryption has for administrator passwords is upgraded from SHA1 to SHA256.

Downgrades from FortiOS 5.6->5.4->5.2->5.0 will keep the administrator password usable. If you need to
downgrade to FortiOS 4.3, remove the password before the downgrade, then login after the downgrade and re-
set password.

Allow multiple FortiManager addresses when configuring central management (388083)

Central management configuration can now support multiple FortiManager addresses. This feature is mainly to
help the case where the FortiGate unit is behind NAT.

FortiGuard can determine a FortiGate's location from its public IP address (393972)

A new CLI command allows users to determine a FortiGate's location from its public IP address through
FortiGuard .

The new CLI command is diagnose sys waninfo.

Deletion of multiple saved configurations supported (308936)

The FortiGate will save multiple configurations and images when revision-backup-on-logout and
revision-image-auto-backup are enabled in config system global.

The deletion of multiple saved configurations is now possible due to changes in the CLI command execute
revision delete config <revision ID>. Where the command only allowed for one revision ID at a
time, it now allows almost ten.

New CLI option to limit script output size (388221)

The new CLI command set output-size limits the size of an auto script in megabytes and prevents the
memory from being used up by the script's output.

CLI Syntax

config system auto-script
edit <script name>

set output-size <integer>
next

end
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Enter an integer value from 10 to 1024. Default is 10.

Enable / disable logging of SSL connection events (375582)

New CLI commands are added to give the user the option to enable or disable logging of SSL connection events.

CLI Syntax

config system global
set log-ssl-connection {enable | disable}

end

Default is disable.

Enabling or disabling static key ciphers (379616)

There is a new option in system global to enable or disable static key ciphers in SSL/TLS connections (e.g,.
AES128-SHA, AES256-SHA, AES128-SHA256, AES256-SHA256). The default is enable.

CLI Syntax

config system global
set ssl-static-key-ciphers {enable | disable}

end

Enhancements to IPS Signatures page (285543)

The IPS signatures list page now shows which IPS package is currently deployed. You can also change the IPS
package by hovering over the information icon next to the IPS package name. Text appears that links directly to
the FortiGate'sSystem > FortiGuard page from the IPS Signatures list page.

Combine multiple commands into a CLI alias (308921)

You can add one or more CLI command to a CLI alias, then use the alias command to run the alias that you
have created to execute the stored commands. For example, create the following alias to run the get
system status command:

config system alias
edit "version"

set command "get system status"
end

Then you can use the following command to run the alias:

alias version

You can use command abbreviations (for example: g sys stat instead of get system status). Use
quotes around the syntax if there are spaces (there usually are).

You can enter alias followed by a ? to view the aliases that you have added.

You can add multiple commands to an alias by pressing Ctrl-Enter after the first line. Press enter at the end of
subsequent lines. And the end of the last line add second quote and press Enter to end the command.

config system alias
edit "debug_flow"

set command "diag debug enable
diag debug flow show console enable"
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end

You can include config commands in an alias as well, for example, create the following alias to bring the port1
and port2 interfaces down:

config system alias
edit port12down

set command "config system interface
edit port1
set status down
next
edit port2
set status down
end"

end

You can combine config, execute, get, and diagnose commands in the same alias, for example:

config system alias
edit "show-info"

set command "show full-configuration alertemail setting
get sys status
dia sys top"

end
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By default, the FortiGate has a super administrator account, called admin, which cannot be deleted. Additional
administrators can be added for various functions, each with a unique user name, password, and set of access
privileges.

The following tasks can be done to add and secure administrative access to a FortiGate:

l Administrator profiles
l Adding a local administrator
l LDAP authentication for administrators
l Other methods of administrator authentication
l Administrator lockout
l Monitoring administrators
l Management access
l Security precautions

Administrator profiles
Administrator profiles define what the administrator can do when logged into the FortiGate. When you set up an
administrator account, you also assign an administrator profile dictating what the administrator will see.
Depending on the nature of the administrator’s work, access level or seniority, you can allow them to view and
configure as much, or as little, as required.

super_admin profile

This profile has access to all components of FortiOS, including the ability to add and remove other system
administrators. For some administrative functions, such as backing up and restoring the configuration, super_
admin access is required. The super_admin profile cannot be deleted or modified, to ensure that there is always a
method to administer the FortiGate.

Lower level administrator profiles cannot backup or restore the FortiOS configuration.

The super_admin profile is used by the default admin account. It is recommended to add a password and
rename this account once you have set up your FortiGate. In order to rename the default account, a second
admin account is required. For more information, see "Administrators" on page 3089.

Creating profiles

To configure administrator profiles go to System > Admin Profiles and select Create New.

On the New Administrator Profile page, you define the components of FortiOS that will be available to view
and/or edit. For example, you can configure a profile so that the administrator can only access the Firewall
Configuration, which includes firewall policies, addresses, services, schedules, packet capture, and some other
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parts of the FortiGate configuration. Any other aspects of the FortiGate configuration, including VPNs and
security profiles, will be hidden from this administrator.

Administrator timeout override per access profile

With the release of FortiOS 5.6.1, administrator profiles can be configured to increase inactivity timeout and
facilitate use of the GUI for central monitoring. This new feature allows the admintimeout value, under
config system accprofile, to be overridden per access profile.

Note that this can be achieved on a per-profile basis, to avoid the option from being unintentionally set globally.

CLI Syntax - Configure admin timeout

config system accprofile
edit <name>

set admintimeout-override {enable | disable}
set admintimeout <0-480> - (default = 10, 0 = unlimited)

next
end

Adding a local administrator
Only administrators with read-write privileges forAdministrator Users can create a new administrator account.

To add an administrator - GUI

1. Go to System > Administrators.
2. Select Create New.
3. Add a Name for the administrator.

The name of the administrator should not contain the characters <>()#"'. Using
these characters in the administrator account name can result in a cross site scripting
(XSS) vulnerability.

4. Enter the Password for the user. This may be a temporary password that the administrator can change later.
Passwords can be up to 256 characters in length. For more information on passwords, see the Passwords
discussion in the Getting Started chapter.

5. Set Type to Local User.
6. Determine if you need to enable Security options Two-factor Authentication orRestrict login to trusted

hosts orRestrict admin to guest account provisioning only.
7. Select OK.

The option to configure guest management administrator's through the GUI is new to
FortiOS 5.6. To create the user group to be used for guest user accounts, go to
Managing Guest Access in the Authentication chapter.

To add an administrator - CLI

config system admin
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edit <admin_name>
set password <password>
set accprofile <profile_name>
set guest-auth {enable | disable}
set user-groups <group-name>

end

The CLI command set user-groups can only be used when guest-auth is set to enable.

LDAP authentication for administrators
Administrators can use remote authentication, such as LDAP, to connect to the FortiGate.

To do this, requires three steps:

l configure the LDAP server
l add the LDAP server to a user group
l configure the administrator account

Configure the LDAP server

First set up the LDAP server as you normally would, and include a group to bind to.

To configure the LDAP server - GUI

1. Go to User & Device > LDAP Servers and select Create New.
2. Enter a Name for the server.
3. Enter the Server IP address or name.
4. Enter the Common Name Identifier and Distinguished Name.
5. Set the Bind Type to Regular and enter the User DN and Password.
6. Select OK.

To configure the LDAP server - CLI

config user ldap
edit <ldap_server_name>

set server <server_ip>
set cnid cn
set dn DC=XYZ,DC=COM
set type regular
set user name CN=Administrator,CN=Users,DC=XYZ,DC=COM
set password <password>
set member-attr <group_binding>

end

Add the LDAP server to a user group

Next, create a user group that will include the LDAP server that was created above.

To create a user group - GUI

1. Go to User & Device > User Groups and select Create New.
2. Enter a Name for the group.
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3. In the section labeled Remote groups, select Create New.
4. Select the Remote Server from the drop-down list.
5. Select OK.

To create a user group - CLI

config user group
edit <group_name>

config match
edit 1

set server-name <LDAP_server>
set group-name <group_name>

end
end

Configure the administrator account

Now you can create a new administrator, where rather than entering a password, you will use the new user group
and the wildcard option for authentication.

To create an administrator - GUI

1. Go to System > Administrators and select Create New.
2. In the Administrator field, enter the name for the administrator.
3. For Type, select Match a user on a remote server group.
4. Select the User Group created above from the drop-down list.
5. SelectWildcard. The Wildcard option allows for LDAP users to connect as this administrator.
6. Select an Admin Profile.
7. Select OK.

To create an administrator - CLI

config system admin
edit <admin_name>

set remote-auth enable
set accprofile super_admin
set wild card enable
set remote-group ldap

end

Other methods of administrator authentication
Admin accounts can use a variety of methods for authentication, including RADIUS, TACACS+, and PKI.

RADIUS authentication for administrators

If you want to use a RADIUS server to authenticate administrators, you must:

l configure the FortiGate to access the RADIUS server
l create the RADIUS user group
l configure an administrator to authenticate with a RADIUS server.
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TACACS+ authentication for administrators

If you want to use a TACACS+ server to authenticate administrators, you must:

l configure the FortiGate to access the TACACS+ server
l create a TACACS+ user group
l configure an administrator to authenticate with a TACACS+ server.

PKI certificate authentication for administrators

To use PKI authentication for an administrator, you must:

l configure a PKI user
l create a PKI user group
l configure an administrator to authenticate with a PKI certificate.

Administrator lockout
By default, the FortiGate sets the number of password retries at three, allowing the administrator a maximum of
three attempts to log into their account before locking the account for a set amount of time.

Both the number of attempts (admin-lockout-threshold) and the wait time before the administrator can
try to enter a password again (admin-lockout-duration) can be configured within the CLI.

To configure the lockout options:

config system global
set admin-lockout-threshold <failed_attempts>
set admin-lockout-duration <seconds>

end

The default value of admin-lockout-threshold is 3 and the range of values is between 1 and 10. The
admin-lockout-duration is set to 60 seconds by default and the range of values is between 1 and
4294967295 seconds.

Keep in mind that the higher the lockout threshold, the higher the risk that someone may be able to break into the
FortiGate unit.

Example:

To set the admin-lockout-threshold to one attempt and the admin-lockout-duration to a five
minute duration before the administrator can try to log in again, enter the commands:

config system global
set admin-lockout-threshold 1
set admin-lockout-duration 300

end

If the time span between the first failed login attempt and the admin-lockout-
threshold failed login attempt is less than admin-lockout-duration, the
lockout will be triggered.
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Monitoring administrators
You can view the administrators logged in using the System Information widget on the Dashboard. The
Current Administrator row that shows the administrator logged in and the total number of administrators
logged in. Selecting Details displays the administrators, where they are logging in from and how (CLI, GUI) and
when they logged in.

You are also able to monitor the activities the administrators perform on the FortiGate using the event logging.
Event logs include a number of options to track configuration changes.

To set logging - GUI

1. Go to Log & Report > Log Settings.
2. Under Event Logging, select Customize and ensure System activity event is selected.
3. Select Apply.

To set logging - CLI

config log eventfilter
set event enable
set system enable

end

To view the logs go to Log & Report > System Events.

Management access
Management access defines how administrators are able to log on to the FortiGate. In NAT mode, access is
configured for each of the FortiGate's interfaces, using the interface's IP to connect. In Transparent mode, a
single management IP address is configured to allow access.

Management access can be via HTTP, HTTPS, Telnet, or SSH sessions. HTTPS and SSH are preferred as they
are more secure. The management computer must connect to an interface that permits management access and
its IP address must be on the same network. If you are using VDOMs, an administrator who is restricted to a
specific VDOM must use a computer that connects to an interface on that VDOM.

You can allow remote administration of the FortiGate; however, it is not recommended, since it could
compromise the security of the FortiGate. If you require remote administration, the following precautions can be
taken to improve the security of a FortiGate:

l Use secure administrator passwords.
l Change these passwords regularly.
l Enable two-factor authentication for administrators.
l Enable secure administrative access to this interface using only HTTPS or SSH.
l Use Trusted Hosts to limit where the remote access can originate from.
l Do not change the system idle timeout from the default value of 5 minutes.
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Security precautions
One potential point of a security breach is at the management computer. Administrators who leave their
workstations for a prolonged amount of time while staying logged into the GUI or CLI leave the firewall open to
malicious intent.

When logging in using a local admin with the default or empty password, a warning
prompt will appear upon login. Admins will be logged out if they have no permissions.

Restrict logins from trusted hosts

Setting up trusted hosts for an administrator limits the addresses from where they can log into FortiOS. The
trusted hosts configuration applies to all forms of administrative access including HTTPS, SSH, ping, and SNMP.
When you identify a trusted host for an administrator account, FortiOS accepts that administrator’s login only
from one of the trusted hosts. A login, even with proper credentials, from a non-trusted host is dropped.

To identify trusted hosts, go to System > Administrators, edit the administrator account, enable Restrict
login to trusted hosts, and add up to ten trusted host IP addresses.

To add two trusted hosts from the CLI:

config system admin
edit <administrator-name>

set trustedhost1 172.25.176.23 255.255.255.255
set trustedhost2 172.25.177.0 255.255.255.0

end

Trusted host IP addresses can identify individual hosts or subnets. Just like firewall policies, FortiOS searches
through the list of trusted hosts in order and acts on the first match it finds. When you configure trusted hosts,
start by adding specific addresses at the top of the list. Follow with more general IP addresses. You don't have to
add addresses to all of the trusted hosts as long as all specific addresses are above all of the 0.0.0.0 0.0.0.0
addresses.

Prevent concurrent administrator sessions

Concurrent administrator sessions occur when multiple people concurrently access the FortiGate using the same
administrator account. This is allowed by default. If you wish to prevent this behavior go to System > Settings
and disable Allow multiple concurrent sessions for each administrator.

From the CLI:

config system global
set admin-concurrent disable

end

Note, if you disable concurrent sessions for an administrator, you will be allowed only one session with the same
username even if it is from the same IP.

Segregated administrative roles

To minimize the effect of an administrator causing errors to the FortiGate configuration and possibly jeopardizing
the network, create individual administrative roles where none of the administrators have super_admin
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permissions. For example, one account is used solely to create security policies, another for users and groups,
another for VPN, and so on.

SSH log in time out

You can take up to 120 seconds to log into the FortiGate when using SSH. You can use the following CLI
command to reduce this time to enhance security:

config system global
set admin-ssh-grace-time <number_of_seconds>

end

The range can be between 10 and 3600 seconds.

HTTPS redirect

When configuring the Administration Settings (found at System > Settings), you can also enable HTTP to
Redirect to HTTPS. When enabled, if a administrator tries to connect to an interface using HTTP, this traffic will
be automatically redirected to use HTTPS instead for a more secure connection.

Administrator log in disclaimers

FortiOS can display a disclaimer before or after logging into the GUI or CLI (or both). In either case the
administrator must read and accept the disclaimer before they can proceed.

Use the following command to display a disclaimer before logging in:

config system global
set pre-login-banner enable

end

Use the following command to display a disclaimer after logging in:

config system global
set post-login-banner enable

end

You can customize the replacement messages for these disclaimers by going to System > Replacement
Messages. Select Extended View to view and edit the Administrator replacement messages.

From the CLI:

config system replacemsg admin pre_admin-disclaimer-text
config system replacemsg admin post_admin-disclaimer-text

Disable the console interface

You can disable your FortiGate's console interface to prevent any unwanted login attempts:

config system console
set login disable

end

Disable other interfaces

If any of the interfaces on the FortiGate are not being used, disable traffic on that interface. This avoids someone
plugging in network cables and potentially causing network bypass or loop issues.
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To disable an interface - GUI

1. Go to Network > Interfaces.
2. Select the interface from the list and select Edit.
3. ForAdministrative Access, select Down.
4. Select OK.

To disable an interface - CLI

config system interface
edit <interface_name>

set status down
end

Self-signed GUI certificates

For increased security, SHA-1 certificate has been replaced by self-sign certificate as the default GUI certificate,
if the BIOS certificate is using SHA-1.
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Administering one or two FortiGate units is fairly simple enough, especially when they are in the same room or
building. However, if you are administering many FortiGate units that may be located in locations in a large
geographical area, or in the world, you will need a more efficient method of maintaining firmware upgrades,
configuration changes, and updates.

The FortiManager family of appliances supply the tools needed to effectively manage any size Fortinet security
infrastructure, from a few devices to thousands of appliances. FortiManager appliances provide centralized
policy-based provisioning, configuration, and update management, as well as end-to-end network monitoring for
added control. Managers can control administrative access and simplify policy deployment using role-based
administration to define user privileges for specific management domains and functions by aggregating
collections of Fortinet appliances and agents into independent management domains. By locally hosting security
content updates for managed devices and agents, FortiManager appliances minimize web filtering rating request
response time and maximize network protection.

This chapter describes the basics of using FortiManager as an administration tool for multiple FortiGate units. It
describes the basics of setting up a FortiGate unit in FortiManager and some key management features you can
use within FortiManager to manage the FortiGate unit. For full details and instructions on FortiManager, see the
FortiManager Administration Guide.

This section includes the topics:

l Adding a FortiGate to FortiManager
l Configuration through FortiManager
l Firmware updates
l FortiGuard
l Backup and restore configurations
l Administrative domains

In order for the FortiGate unit and FortiManager unit to properly connect, both units
must have compatible firmware. To find out if your firmware is compatible, refer to the
FortiOS or FortiManager Release Notes.

Adding a FortiGate to FortiManager
Before you can maintain a FortiGate unit using a FortiManager unit, you need to add it to the FortiManager. This
requires configuration on both the FortiGate and FortiManager. This section describes the basics to configure
management using a FortiManager device.

Central management configuration can now support multiple FortiManager addresses. This feature is mainly to
help the case where the FortiGate unit is behind NAT.
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FortiGate configuration

These steps ensure that the FortiGate unit will be able to receive updated antivirus and IPS updates and allow
remote management through the FortiManager system or FortiCloud service. You can add a FortiGate unit
whether it is running in either NAT mode or transparent mode. The FortiManager appliance provides remote
management of a FortiGate unit over TCP port 541.

If you have not already done so, register the FortiGate unit by visiting http://support.fortinet.com and select
Product Registration. By registering your unit, you will receive updates to the FortiGuard services and will also
ensure your access to technical support.

You must enable the FortiGate management option so the FortiGate unit can accept management updates to
firmware and FortiGuard services.

To configure the FortiGate unit - GUI

1. Log in to the FortiGate unit.
2. Go to System > Settings.
3. UnderCentral Management, select FortiManager.
4. Enter the IP/Domain Name of the FortiManager unit.
5. Select Apply.

As an additional security measure, you can also select Registration Password and enter a password to connect
to the FortiManager.

After you select Apply, a message appears stating that the FortiGate's request was received by the
FortiManager and is now waiting for confirmation.

On the FortiManager, go to Device Manager and use the Add Devicewizard.

If your FortiGate has no connectivity, see FortiGuard Licensing for FortiGates with
Limited or No Connectivity for information on configuring your FortiManager and
FortiGate.

To configure the FortiGate unit - CLI

config system central-management
set type fortimanager
set fmg <ip_address>

end

To use the registration password, enter:

execute central-mgmt register-device <fmg-serial-no><fmg-register-password><fgt-
usrname><fgt-password>

Configuring an SSL connection

An SSL connection can be configured between the two devices and an encryption level selected. Use the
following CLI commands in the FortiGate CLI to configure the connection:

config system central-management
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set enc-algorithm {default | high | low}
end

The defaultencryption automatically sets high and medium encryption algorithms. Algorithms used for high,
medium, and low follows openssl definitions:

l High - Key lengths larger than 128 bits, and some cipher suites with 128-bit keys.

Algorithms are: DHE-RSA-AES256-SHA:AES256-SHA: EDH-RSA-DES-CBC3-SHA: DES-CBC3-SHA:DES-CBC3-
MD5:DHE-RSA-AES128-SHA:AES128-SHA

l Medium - Key strengths of 128 bit encryption.

Algorithms are: RC4-SHA:RC4-MD5:RC4-MD

l Low - Key strengths of 64 or 56 bit encryption algorithms but excluding export cipher suites

Algorithms are: EDH-RSA-DES-CDBC-SHA; DES-CBC-SHA; DES-CBC-MD5.

FortiManager configuration

Once the connection between the FortiGate unit and the FortiManager unit has been configured, you can add the
FortiGate to the Device Manager in the FortiManager unit’s GUI. For details on completing the configuration, see
the FortiManager Administration Guide.

Configuration updates through FortiManager
With the FortiManager system, you can monitor and configure multiple FortiGate units from one location. Using
the FortiManager’s Device Manager, you can view the FortiGate units and make the usual configuration updates
and changes, without having to log in and out of multiple FortiGate units.

FortiManager enables you to complete the configuration, by going to the Device Manager, selecting the
FortiGate unit and using the same menu structure and pages as you would see in the FortiGate web-based
manager. All changes to the FortiGate configuration are stored locally on the FortiManager unit until you
synchronize with the FortiGate unit.

When a FortiGate unit is under control of a FortiManager system, administrators will not be able to change the
configuration using the FortiGate. When trying to change options, the unit displays a message that it is
configured through FortiManager, and any changes may be reverted.

With the release of FortiOS 5.6, central management configuration can now support multiple FortiManager
addresses. This feature is mainly to help the case where the FortiGate unit is behind NAT.

Global objects

If you are maintaining a number of FortiGate units within a network, many of the policies and configuration
elements will be the same across the corporation. In these instances, the adding and editing of many of the same
policies will be come a tedious and error-prone activity. With FortiManager global objects, this level of
configuration is simplified.

A global object is an object that is not associated specifically with one device or group. Global objects include
security policies, a DNS server, VPN, and IP pools.

The Global Objects window is where you can configure global objects and copy the configurations to the
FortiManager device database for a selected device or a group of devices. You can also import configurations
from the FortiManager device database for a selected device and modify the configuration as required.
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When configuring or creating a global policy object the interface, prompts, and fields are the same as creating the
same object on a FortiGate unit using the FortiGate GUI.

Locking the FortiGate GUI

When you use the FortiManager to manager multiple FortiGate units, a local FortiGate unit becomes locked from
any configuration changes using the GUI for most administrators. The super_admin will still be able to make
changes to the configuration; however, this is not recommended as it may cause conflicts with the FortiManager.

FortiGuard
The FortiGuard Distribution Network (FDN) provides FortiGuard services for your FortiManager system and its
managed devices and FortiClient agents. The FDN is a world-wide network of FortiGuard Distribution Servers
(FDS), which update the FortiGuard services on your FortiManager system on a regular basis so that your
FortiManager system is protected against the latest threats.

In FortiGuard Management, you can configure the FortiManager system to act as a local FDS, or use a web proxy
server to connect to the FDN. FortiManager systems acting as a local FDS synchronize their FortiGuard service
update packages with the FDN, then provide these updates and look up replies to your private network’s
FortiGate devices. The local FDS provides a faster connection, reducing Internet connection load and the time
required to apply frequent updates, such as antivirus signatures, to many devices.

The default port used for FortiGuard services is UDP/8888.

The FortiGuard services available on the FortiManager system include:

l Antivirus and IPS engines and signatures
l Web filtering and email filtering rating databases and lookups (select systems)
l Vulnerability scan and management support for FortiAnalyzer

To view and configure these services, go to FortiGuard > Advanced Settings on your FortiManager.

FortiManager can also connect to the FortiGuard Distribution Network (FDN) to receive push updates for IPS
signatures and antivirus definitions. These updates can then be used to update multiple FortiGate units
throughout an organization. By using the FortiManager as the host for updates, bandwidth use is minimized as
updates are downloaded to one source instead of many.

To receive IPS and antivirus updates from FortiManager, indicate an alternate IP address on the FortiGate unit.

To configure updates from FortiManager

1. Go to System > FortiGuard on your FortiGate.
2. UnderAntiVirus & IPS Updates, enable both Accept push updates and Use override push.
3. Enter the IP address of the FortiManager unit.
4. Select Apply.
The FortiManager can also be operated as a local FDS server when it is in a closed network with no Internet
connectivity. See FortiGuard Licensing for FortiGates with Limited or No Connectivity.

New extended database version OIDs for AV and IPS

In FortiOS 5.6, new extended database version OIDs ensure accurate display of the AntiVirus and IPS databases
in use when you go to System > FortiGuard.
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Enhancements to IPS Signatures page

The IPS signatures list page now shows which IPS package is currently deployed. Users can also change their IPS
package by hovering over the information icon next to the IPS package name. Text will appear that links directly
to the FortiGate'sSystem > FortiGuard page from the IPS Signatures list page.

The central management FortiGuard server list can include FQDNs

This feature, introduced in FortiOS 5.4.0, implements support of FQDN, to make it an option for central-
management server-list. This feature can be set through the GUI and the CLI.

GUI Changes

On System > FortiGuard > Override FortiGuard Servers > Create New / Edit, a new option, FQDN is
added forAddress Type.

CLI Changes

config server-list
edit 1

set server-type {update|rating}
set addr-type {ipv4|ipv6|fqdn} <== added fqdn
set server-address ipv4
set server-address6 ipv6
set fqdn FQDN <== added

end
end

Sending malware statistics to FortiGuard

To support following malware trends and making zero-day discoveries, FortiGate units send encrypted statistics
to FortiGuard about IPS, Application Control, and AntiVirus events detected by the FortiGuard services running
on your FortiGate. FortiGuard uses the statistics collected to achieve a balance between performance and
security effectiveness by moving inactive signatures to an extended signature database.

The statistics include some non-personal information that identifies your FortiGate and its country. The
information is never shared with external parties. You can choose to disable the sharing of this information by
entering the following CLI command:

config system global
set fds-statistics disable

end

Configuring FortiGuard licensing for FortiGates with limited or no connectivity

If you purchased FortiGuard services and registered your FortiGate unit, a FortiGate connected to the Internet
should automatically connect to the FortiGuard Distribution Network (FDN) to validate the license and download
FDN updates. In some high security environments however, Internet service from internal FortiGate appliances is
restricted. This section describes how to configure a FortiGate with limited or no internet connectivity to allow a
local FortiManager appliance to act as a local FortiGuard Distribution Server (FDS) and to provide both license
validation and FDN updates.
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Preliminary steps

1. Register the FortiGate by logging into Fortinet Support and going to Asset > Register/Renew. For a physical
FortiGate appliance, enter the serial number. For a FortiGate virtual machine, enter the registration number.
Finish the steps to complete registration.

2. For FortiGate VMs, the registration process creates a unique license file that is available underAsset >
View/Manage Products. Select the correct device, and download the license file.

This section assumes:

l internal FortiGate appliances can access a local FortiManager physical or virtual appliance.
l the FortiManager is operating with 5.6 firmware.

The FortiManager Administration Guide (version 5.6) provides information on what you must do before you can
use your FortiManager as a local FDS. Consult the FortiGuard section of the FortiManager online help for details.

The following topics are covered in this section:

l Configure FortiManager as a local FDN
l Configure FortiGate to access a local FortiManager as FDN
l Useful troubleshooting commands

Configure FortiManager as a local FDN

The following procedures assist in the configuration of a FortiManager to provide license validation and FDN
updates to a FortiGate with limited or no internet connectivity.

l Configure FortiManager with Internet connectivity as a local FDN server
l Configure FortiManager without Internet connectivity as a local FDN server

Configure FortiManager with Internet connectivity as a local FDN server

1. From the FortiManager GUI, select System Settings > Network.
2. Check the following Service Access options on interfaces that will serve FortiGates as the local FDN server:

l FortiGate Updates
l Web Filtering

3. Select FortiGuard > Settings.
4. Enable the types of FDN services that you want to provide through FortiManager’s built-in FDS.
5. ClickApply.

The built-in FDS attempts to connect to the FDN.

Add these steps to configure FortiManager to access FDN services through a proxy server:

6. Expand FortiGuard AntiVirus and IPS Settings.

a. Enable Use Web Proxy.

b. Enter the IP address and credentials for the proxy server.
7. Expand FortiGuard Web Filter and Email Filter Settings.

a. Enable Use Web Proxy.

b. Enter the IP address and credentials for the proxy server.
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8. If the proxy server requires authentication, enter the user name and password.
9. ClickApply.

Configure FortiManager without Internet connectivity as a local FDN server

The FortiManager can be operated as a local FDS server when it is in a closed network with no Internet
connectivity.

Without a connection to a FortiGuard server, update packages and licenses must be manually downloaded from
support, and then uploaded to the FortiManager. Through this feature, known asClosed Network Mode, the
FortiManager can then provide updates and validate licenses for local FortiGate units without Internet access.

To configure the FortiManager in Closed Network Mode, complete the following tasks:

l Enable Closed Network Mode
l Request FortiGate license validation information
l Download FortiGuard service update files
l Configure FortiManager in Closed Network Mode

Enable Closed Network Mode

1. From the FortiManager GUI, go to FortiGuard > Settings and disable Enable Communication with
FortiGuard Server.
Or, from the FortiManager CLI, enable Closed Network Mode by disabling FDS access from the public FDN:

config fmupdate publicnetwork
set status disable

end

Once in Closed Network Mode, you must manually import FortiManager service
packages, updates, and license upgrades.

Request FortiGate license validation information

1. Create a Customer Service ticket with Fortinet Support underAssistance > Create Ticket > Customer
Service > Submit Ticket.

2. Enter the serial number. UnderCategory, select CS Contract/License.
3. In the Comment field, ask for an "entitlement file” for the FortiGate. Provide the serial number and license

number available in Asset > Manage/View Products ><Select product>.
Example:
Serial Number: FGVM010000024628
License Number: FGVM0035444

As with asset registration, for large numbers of FortiGates you can attach a
spreadsheet of serial and license numbers for Customer Service. They will provide a
single entitlement file that contains validation information for all FortiGates in the
spreadsheet. All FortiGates must be registered under the same account. Devices
registered under different accounts cannot be combined into the same entitlement
file.

4. You will receive an entitlement file from Customer Service.
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Download FortiGuard service update files

1. From Fortinet Support, navigate to Download > FortiGuard Service Updates. Download the Virus
Definition, Attack Definition, andMobile Malware files for the appropriate version of FortiGate and FortiOS.
These files are named in the form vsigupdate*.pkg and nids*.pkg.

2. Export the FortiGuard Web Filter and Anti-Spam service updates from a FortiManager that has Internet
connectivity by entering the following CLI command:

execute fmupdate {ftp | scp | tftp} export <type> <remote_file> <ip> <port>
<remote_path> <user> <password>

Enter types url and spam.

Variable Description

{ftp | scp | tftp} Select the file transfer protocol to use: ftp, scp, or tftp.

<type>
Select the type of file to export or import. The following options are
available: av-ips, fct-av, url, spam, file-query, license-
fgt, license-fct, custom-url, or domp.

<remote_file> Update manager packet file name on the server or host.

<ip> Enter the FQDN or the IP address of the server.

<port> Enter the port to connect to on the remote SCP host. Range: 1 to
65535 .

<remote_path>
Enter the name of the directory of the file to download from the FTP
server or SCP host. If the directory name has spaces, use quotes
instead.

<user> Enter the user name to log into the FTP server or SCP host.

<password> Enter the password to log into the FTP server or SCP host.

Configure FortiManager in Closed Network Mode

Go to FortiGuard > Settings to configure FortiManager as a local FDS server and to upload update packages
and licenses.
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1. ToggleOFF Enable Communication with FortiGuard Server to disable communication with the FortiGuard
servers.

2. ToggleON Enable Antivirus and IPS Service.
Select software versions for FortiGate, FortiClient, FortiAnalyzer, and FortiMail.

3. ToggleON Enable Web Filter Service.
When uploaded to FortiManager, the Web Filter database is displayed.

4. ToggleON Enable Email Filter Service.
When uploaded to FortiManager, the Email Filter database is displayed.
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5. UnderUpload Options for FortiGate/FortiMail
l Upload AntiVirus/IPS Packages. Browse for the file you downloaded from the Customer Service

Support portal on your management computer. Select OK to upload the package to FortiManager.
Repeat for each file downloaded from the Customer Service Support portal.

l UploadWeb Filter Database. Browse for the file you exported from the FortiManager that is connected
to the Internet. Select OK to upload the package to FortiManager in the closed network mode. As the
database can be large, uploading with the CLI is recommended. See the instructions below

l Upload Email Filter Database. Browse for the file you exported from the FortiManager that is connected
to the Internet. Select OK to upload the package to FortiManager in closed network mode. As the
database can be large, uploading with the CLI is recommended. See the instructions below.

l Select Service License to import the FortiGate license. Browse for the entitlement file on your
management computer. Select OK to upload the package to FortiManager. A license file can be obtained
from support by requesting your account entitlement for the device (see "Configure FortiManager without
Internet connectivity as a local FDN server" on page 3103).

6. UnderUpload Options for FortiClient, select AntiVirus/IPS Packages to upload the FortiClient AntiVirus/IPS
packages. Browse for the file downloaded from the Customer Service & Support portal on your management
computer. Select OK to upload the package to FortiManager.

Uploading packages with the CLI

You can upload packages and licenses with the CLI. You should use this method when packages are large, such
as database packages.

First, disable communications with the FortiGuard server and enable a closed network with the following CLI
commands:

config fmupdate publicnetwork
set status disable

end

Then, upload an update package or license by loading the package or license file to an FTP, SCP, or TFTP
server.

Run the following CLI command:

execute fmupdate { ftp | scp | tftp } import < av-ips | fct-av | url | spam | file-query |
license-fgt | license-fct | custom-url | domp > <remote_file> <ip> <port> <remote_
path> <user> <password>

Configure FortiGate without Internet connectivity to access a local FortiManager as FDN

By default, FortiGate connects to the public FDN to validate its license and download security feature updates,
including databases and engines for security feature updates such as AntiVirus and IPS. Your FortiGate can be
configured to use a local FortiManager for both license validation and FDN updates.

In the case of a FortiGate without Internet access, the full configuration must be done before the license is
uploaded. The moment the FortiGate receives a license file (from the GUI or CLI), it immediately attempts to
access the public FDN to validate the license. Until the license is validated, an administrator cannot log in to the
GUI and some CLI commands are unavailable, including those needed to define a local FDN server. This makes
it very difficult to add the necessary commands to point the FortiGate to a local FortiManager for license
validation.
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This document describes how to configure a FortiGate for local FDN access, and provides a workaround to fix a
FortiGate that is unable to access a public license validation server.

Follow this procedure to configure a FortiGate to use a local FortiManager for FDN access:

Completing these steps in a different order may cause the process to fail, and make
the FortiGate unable to validate its license.

From the FortiGate CLI:

1. Configure central management settings:
config system central-management

config server-list
edit 1

set server-type update rating
set server-address <fortimanager_ip>

next
end
set include-default-servers disable

end

2. Upload the license using TFTP using the CLI:
execute restore vmlicense tftp <filename>.lic <tftp_ip>

The FortiGate will reboot.

3. Complete the central management configuration:
config system central-management

set fmg <fortimanager_ip>
end

From the FortiManager GUI:

You must manually add devices to the FortiManager unit.

As a result of the CLI commands entered on your FortiGate unit, the device is displayed on the FortiManager GUI
in the Unregistered Devices list. located in he Device Manager pane for the root ADOM.

When ADOMs are enabled, the device must be assigned to an ADOM when it is registered.

To manually add devices:

1. Confirm that central management is enabled for the device (as above).
2. In FortiManager, select the root ADOM, and go to Device Manager.
3. In the tree menu, clickUnregistered Devices. The content pane displays the unregistered devices.
4. Select the unregistered device or devices, then clickAdd. The Add Device dialog box opens.
5. If ADOMs are enabled, select the ADOM in the Add the following device(s) to ADOM list. If ADOMs are

disabled, select root.
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6. Type the login and password for the device(s).
7. ClickOK to register the device(s).
The devices are added.

Troubleshooting

The following commands can be useful for determining the state of license validation and FDN service
connectivity, and gathering information about any connectivity failures. For additional troubleshooting
commands, visit the FortiOS 5.6 CLI Reference site.

On FortiGate:

l get system status

l get webfilter status

l get system auto-update version

l get system auto-update status

On FortiGate-VM:

l diagnose hardware sysinfo vm full

l diagnose debug vm-print-license

l diagnose hardware sysinfo vminfo

On FortiManager:

l diagnose fmupdate vm-license

Firmware updates
A FortiManager unit can also perform firmware updates for multiple FortiGate units, saving time rather than
upgrading each FortiGate unit individually.

The FortiManager unit stores local copies of firmware images, either by downloading images from the Fortinet
Distribution Network (FDN) or by accepting firmware images that are uploaded from the management computer.

If you are using the FortiManager unit to download firmware images, the FDN first validates device licenses and
support contracts and then provides a list of currently available firmware images. For devices with valid Fortinet
Technical Support contracts, you can download new firmware images from the FDN and the firmware release
notes.
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After firmware images have been either downloaded from the FDN or imported to the firmware list, you can either
schedule or immediately upgrade/downgrade a device or group of device’s firmware.

See the FortiManager Administration Guide for more information on updating the FortiGate firmware using the
FortiManager central management.

Administrative domains
FortiManager administrative domains enable the super_admin to create groupings of devices for configured
administrators to monitor and manage. FortiManager can manage a large number of Fortinet appliances. This
enables administrators to maintain managed devices specific to their geographic location or business division.
This also includes FortiGate units with multiple configured VDOMs.

Each administrator is tied to an administrative domain (ADOM). When that particular administrator logs in, they
see only those devices or VDOMs configured for that administrator and ADOM. The one exception is the super_
admin account that can see and maintain all administrative domains and the devices within those domains.

Administrative domains are not enabled by default and enabling and configuring the domains can only be
performed by the super_admin.

Backup and restore configurations
A FortiManager unit stores configuration files for backup and restore purposes. A FortiManager also enables you
to save revisions of configuration files. Configuration backups occur automatically when the administrator logs
out or the administrator login session expires.

FortiManager also enables you to view differences between different configurations to identify where changes
have been made.
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Monitoring

With network administration, the first step is installing and configuring the FortiGate unit to be the protector of the
internal network. Once the system is running efficiently, the next step is to monitor the system and network
traffic, making configuration changes as necessary when a threat or vulnerability is discovered.

This chapter discusses the various methods of monitoring both the FortiGate unit and the network traffic through
a range of different tools available within FortiOS.

This section includes the topics:

l Dashboard
l Monitor menus
l Logging
l Alert email
l SNMP
l SNMP get command syntax

Dashboard
The FortiOS dashboard provides a location to view real-time system information. By default, the dashboard
displays the key statistics of the FortiGate unit itself, providing the memory and CPU status, as well as the health
of the ports, whether they are up or down and their throughput.

The FortiOS 5.6 Dashboard has a new layout with a Network Operations Center (NOC) view with a focus on
alerts. Widgets are interactive; by clicking or hovering over most widgets, the user can get additional information
or follow links to other pages.

Enhancements to the GUI dashboard and its widgets are:

l Multiple dashboard support.
l VDOM and global dashboards.
l Updated resize control for widgets.
l Notifications moved to the top header bar (moved existing dashboard notifications to the header and added

additional ones).
l Reorganization of Add Widget dialog.
l NewHost Scan Summarywidget.
l New Vulnerabilities Summarywidget that displays endpoint vulnerability information much like the FortiClient

Enterprise Management Server (EMS) summary.
l Multiple bug fixes.
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Features that were only visible through old dashboard widgets have been placed elsewhere in the GUI:

l Restore configuration.
l Configuration revisions.
l Firmware management.
l Enabling / disabling VDOMs.
l Changing inspection mode.
l Changing operation mode.
l Shutdown / restart device.
l Changing hostname.
l Changing system time.

The followingwidgets are displayed by default:

l System Information
l Licenses
l FortiCloud
l Security Fabric
l Administrators
l CPU
l Memory
l Sessions
l Bandwidth
l Virtual Machine (on VMs and new to FortiOS 5.6.1)

The following optional widgets are available:

l Interface Bandwidth
l Disk Usage
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l Security Fabric Risk
l Advanced Threat Protection Statistics
l Log Rate
l Session Rate
l Sensor Information
l HAStatus
l Host Scan Summary
l Vulnerabilities Summary
l FortiView (new to FortiOS 5.6.1)

The following widgets have been removed:

l CLI Console
l Unit Operation
l Alert Message Console

System Information

FortiGuard WAN IP blacklist service is now online

The Fortiguard WAN IP blacklist service was not online in FortiOS 5.6.0. In FortiOS 5.6.1, a notification appears
on the Dashboard when WAN IP is blacklisted. Clicking on the notification (bell icon) brings up the blacklist
details.
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Licenses

Hovering over the Licenseswidget will cause status information (and, where applicable, database information)
on the licenses to be displayed for FortiCare Support, IPS & Application Control, AntiVirus,Web
Filtering, Mobile Malware, and FortiClient. The image below shows FortiCare Support information along
with the registrant's company name and industry.

Clicking in the Licenseswidget will provide you with links to other pages, such asSystem > FortiGuard or
contract renewal pages.

FortiCloud

This widget displays FortiCloud status and provides a link to activate FortiCloud.
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Fortinet Security Fabric

The Security Fabricwidget is documented in the Security Fabric section of theWhat's New document.

Administrators

This widget allows you to view which administrators are logged in and how many sessions are active. The link
directs you to a page displaying active administrator sessions.

CPU

The real-time CPU usage is displayed for different timeframes.
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Memory

Real-time memory usage is displayed for different time frames. Hovering over any point on the graph displays
percentage of memory used along with a timestamp.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

3115



Monitoring Chapter 28 - System Administration

Sessions

Bandwidth
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Virtual Machine

FortiOS 5.6.1 introduces a VM widget with these features:

l License status and type.
l CPU allocation usage.
l License RAM usage.
l VMX license information (if the VM supports VMX).
l If the VM license specifies 'unlimited' the progress bar is blank.
l If the VM is in evaluation mode, it is yellow (warning style) and the dashboard show evaluation days used.

l Widget is shown by default in the dashboard of a FortiOS VM device.
l Removed VM information from License widget at Global > Dashboard.
l License info and Upload License button provided on pageGlobal > System > FortiGuard.
l Updated 'Upload VM License' page:

l Added license RAM usage and VMX instance usage.
l Replaced file input component.

Monitor menus
TheMonitormenus enable you to view session and policy information and other activity occurring on your
FortiGate unit. The monitors provide the details of user activity, traffic and policy usage to show live activity.
Monitors are available for DHCP, routing, security policies, traffic shaping, load balancing, security features,
VPN, users, and WiFi.

Logging
FortiOS provides a robust logging environment that enables you to monitor, store, and report traffic information
and FortiGate events, including attempted log ins and hardware status. Depending on your requirements, you
can log to a number of different hosts.
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To configure logging in the web-based manager, go to Log & Report > Log Settings.

To configure logging in the CLI use the commands config log <log_location>.

For details on configuring logging see the Logging and Reporting Guide.

If you will be using several FortiGate units, you can also use a FortiAnalyzer unit for logging. For more
information, see the FortiAnalyzer Administration Guide.

Syslog server

An industry standard for collecting log messages, for off-site storage. In the web-based manager, you are able to
send logs to a single syslog server, however in the CLI you can configure up to three syslog servers where you can
also use multiple configuration options. For example, send traffic logs to one server, antivirus logs to another.
The FortiGate unit sends Syslog traffic over UDP port 514. Note that if a secure tunnel is configured for
communication to a FortiAnalyzer unit, then Syslog traffic will be sent over an IPsec connection, using UPD
500/4500, Protocol IP/50.

To configure a Syslog server in the web-based manager, go to Log & Report > Log Settings. In the CLI use
the commands:

config log syslogd setting
set status enable
set server <IP address or FQDN of syslog server>

end

Further options are available when enabled to configure a different port, facility and server IP address.

For Syslog traffic, you can identify a specific port/IP address for logging traffic. Configuration of these services is
performed in the CLI, using the command set source-ip. When configured, this becomes the dedicated port
to send this traffic over.

For example, to set the source IP of a Syslog server to be on the DMZ1 port with an IP of 192.168.4.5, the
commands are:

config log syslogd setting
set status enable
set source-ip 192.168.4.5

end

You must configure the secure tunnel on both ends of the tunnel, the FortiGate unit
and the FortiAnalyzer unit.

Alert email
As an administrator, you want to be certain you can respond quickly to issues occurring on your network or on the
FortiGate unit. Alert emails provide an efficient and direct method of notifying an administrator of events. By
configuring alert messages, you can define the threshold when a problem becomes critical and needs attention.
When this threshold is reached, the FortiGate unit will send an email to one or more individuals, notifying them of
the issue.
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In the following example, the FortiGate unit is configured to send email to two administrators (admin1 and
admin2) when multiple intrusions are detected every two minutes. The FortiGate unit has its own email address
on the mail server.

To configure the email service

1. Go to System > Advanced.
2. In the Email Service, enable Use Custom Email Server, complete the following and select Apply:

SMTP Server Enter the address or name of the email server. For example,
smtp.example.com.

Default Reply To Enter an email address to associate with the alert email. This field is
optional. If you enter an email address here, it overrides the email address
entered when configuring alert email in Log & Report > Alert E-mail.

Authentication Enable authentication if required by the email server.

Security mode Choose between None, SMTPS or STARTTLS

Port 25

To configure alert email - GUI

1. Go to Log & Report > Alert E-mail.
2. Enter the information:

Email from fortigate@example.com

Email to admin1@example.com

admin2@example.com

3. For the Interval Time, enter 2.
4. Select Intrusion Detected.
5. Select Apply.

To configure alert email - CLI

config system email-server
set port 25
set server smtp.example.com
set authenticate enable
set username FortiGate
set password *************

end
config alertemail setting

set username fortigate@example.com
set mailto1 admin1@example.com
set mailto2 admin2@example.com
set filter category
set IPS-logs enable

end
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SNMP
Simple Network Management Protocol (SNMP) enables you to monitor hardware on your network. You can
configure the hardware, such as the FortiGate SNMP agent, to report system information and send traps (alarms
or event messages) to SNMPmanagers. An SNMPmanager, or host, is a typically a computer running an
application that can read the incoming trap and event messages from the agent and send out SNMP queries to
the SNMP agents. A FortiManager unit can act as an SNMPmanager to one or more FortiGate units. FortiOS
supports SNMP using IPv4 and IPv6 addressing.

By using an SNMPmanager, you can access SNMP traps and data from any FortiGate interface or VLAN
subinterface configured for SNMPmanagement access. Part of configuring an SNMPmanager is to list it as a
host in a community on the FortiGate unit it will be monitoring. Otherwise, the SNMPmonitor will not receive any
traps from that FortiGate unit or be able to query that unit.

The FortiGate SNMP implementation is read-only. SNMP v1, v2c, and v3 compliant SNMPmanagers have read-
only access to FortiGate system information through queries and can receive trap messages from the FortiGate
unit.

To monitor FortiGate system information and receive FortiGate traps, you must first compile the Fortinet and
FortiGate Management Information Base (MIB) files. AMIB is a text file that describes a list of SNMP data
objects that are used by the SNMPmanager. These MIBs provide information the SNMPmanager needs to
interpret the SNMP trap, event, and query messages sent by the FortiGate unit SNMP agent.

FortiGate core MIB files are available for download by going to System > SNMP and selecting the download link
on the page.

The Fortinet implementation of SNMP includes support for most of RFC 2665 (Ethernet-like MIB) and most of
RFC 1213 (MIB II). For more information, see “Fortinet MIBs”. RFC support for SNMP v3 includes Architecture
for SNMP Frameworks (RFC 3411), and partial support of User-based Security Model (RFC 3414).

SNMP traps alert you to events that occur such as a full log disk or a virus detected.

SNMP fields contain information about the FortiGate unit, such as CPU usage percentage or the number of
sessions. This information is useful for monitoring the condition of the unit on an ongoing basis and to provide
more information when a trap occurs.

The FortiGate SNMP v3 implementation includes support for queries, traps, authentication, and privacy.
Authentication and encryption are configured in the CLI. See the system snmp user command in the
FortiGate CLI Reference.

New to FortiOS 5.6

New SNMP trap for bypass events

When bypass mode is enabled or disabled on FortiGate units that are equipped with bypass interfaces and
support AMCmodules, a new SNMP trap is generated and logs bypass events.

Implement SNMP support for NAT Session monitoring which includes new SNMP OIDs

FortiOS 5.6 implements a new feature providing SNMP support for NAT session monitoring. The resulting new
SNMP object identifier (OID) is:
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FORTINET-FORTIGATE-
MIB:fortinet.fnFortiGateMib.fgFirewall.fgFwIppools.fgFwIppTables.fgFwIppStatsTable.fgFwIppStatsEntry
1.3.6.1.4.1.12356.101.5.3.2.1.1

Additionally, there are eight new items:

.fgFwIppStatsName .1

.fgFwIppStatsType .2

.fgFwIppStatsStartIp .3

.fgFwIppStatsEndIp .4

.fgFwIppStatsTotalSessions .5

.fgFwIppStatsTcpSessions .6

.fgFwIppStatsUdpSessions .7

.fgFwIppStatsOtherSessions .8

SNMP configuration settings

Before a remote SNMPmanager can connect to the FortiGate agent, you must configure one or more FortiGate
interfaces to accept SNMP connections by going to Network > Interfaces. Select the interface and, in the
Administrative Access, select SNMP.

For VDOMS, SNMP traps can only be sent on interfaces in the management VDOM. Traps cannot be sent over
other interfaces outside the management VDOM.

To configure SNMP settings, go to System > SNMP.

SNMP Agent Select to enable SNMP communication.

Description Enter descriptive information about the FortiGate unit. The description can
be up to 35 characters.

Location Enter the physical location of the FortiGate unit. The system location
description can be up to 35 characters long.

Contact Enter the contact information for the person responsible for this FortiGate
unit. The contact information can be up to 35 characters.

SNMP v1/v2c section
To create a new SNMP community, see SNMPCommunity.

Community Name The name to identify the community.

Queries Indicates whether queries protocols (v1 and v2c) are enabled or disabled. A
green check mark indicates queries are enabled; a gray x indicates queries
are disabled. If one query is disabled and another one enabled, there will
still be a green check mark.
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Traps

Indicates whether trap protocols (v1 and v2c) are enabled or disabled. A
green check mark indicates traps are enabled; a gray x indicates traps are
disabled. If one query is disabled and another one enabled, there will still
be a green check mark.

Enable Select the check box to enable or disable the community.

SNMP v3 section
To create a new SNMP community, see SNMPCommunity page.

User Name The name of the SNMPv3 user.

Security Level The security level of the user.

Notification Host The IP address or addresses of the host.

Queries Indicates whether queries are enabled or disabled. A green check mark
indicates queries are enabled; a gray x indicates queries are disabled

New SNMP Community page

Community Name Enter a name to identify the SNMP community

Hosts (section)

IP Address

Enter the IP address and Identify the SNMPmanagers that can use the
settings in this SNMP community to monitor the FortiGate unit.

You can also set the IP address to 0.0.0.0 to so that any SNMPmanager
can use this SNMP community.

Delete Removes an SNMPmanager from the list within the Hosts section.

Add Select to add a blank line to the Hosts list. You can add up to eight SNMP
managers to a single community.

Queries (section)

Protocol The SNMP protocol. In the v1 row, this means that the settings are for
SNMP v1. In the v2c row, this means that the settings are for SNMP v2c.

Port Enter the port number (161 by default) that the SNMPmanagers in this
community use for SNMP v1 and SNMP v2c queries to receive
configuration information from the FortiGate unit. Select the Enable check
box to activate queries for each SNMP version.

Note: The SNMP client software and the FortiGate unit must use the same
port for queries.

Enable Select to enable that SNMP protocol.
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Traps (section)

Protocol The SNMP protocol. In the v1 row, this means that the settings are for
SNMP v1. In the v2c row, this means that the settings are for SNMP v2c.

Local Enter the remote port numbers (port 162 for each by default) that the
FortiGate unit uses to send SNMP v1 or SNMP v2c traps to the SNMP
managers in this community. Select the Enable check box to activate traps
for each SNMP version.

Note: The SNMP client software and the FortiGate unit must use the same
port for traps.

Remote

Enter the remote port number (port 162 is default) that the FortiGate unit
uses to send SNMP v1 or v2c traps to the SNMPmanagers in this
community.

Note: The SNMP client software and the FortiGate unit must use the same
port for queries.

Enable Select to activate traps for each SNMP version.

SNMP Event

Enable each SNMP event for which the FortiGate unit should send traps to
the SNMPmanagers in this community.

CPU Over usage traps sensitivity is slightly reduced, by spreading values
out over 8 polling cycles. This prevents sharp spikes due to CPU intensive
short-term events such as changing a policy.

Power Supply Failure event trap is available only on some models.

AMC interfaces enter bypass mode event trap is available only on
models that support AMCmodules.

Enable Select to enable the SNMP event.

Create New SNMP V3 User

User Name Enter the name of the user.

Security Level Select the type of security level the user will have.

Notification Host Enter the IP address of the notification host. If you want to add more than
one host, after entering the IP address of the first host, select the plus sign
to add another host.

Enable Query Select to enable or disable the query. By default, the query is enabled.

Port Enter the port number in the field.

Events Select the SNMP events that will be associated with that user.
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Gigabit interfaces

When determining the interface speed of a FortiGate unit with a 10G interface, the IF-MIB.ifSpeed may not
return the correct value. IF-MIB.ifSpeed is a 32-bit gauge used to report interface speeds in bits/second and
cannot convert to a 64-bit value. The 32-bit counter wrap the output too fast to be accurate.

In this case, you can use the value ifHighSpeed. It reports interface speeds in megabits/second. This ensures
that 10Gb interfaces report the correct value.

SNMP agent

You need to first enter information and enable the FortiGate SNMPAgent. Enter information about the FortiGate
unit to identify it so that when your SNMPmanager receives traps from the FortiGate unit, you will know which
unit sent the information.

To configure the SNMP agent - GUI

1. Go to System > SNMP.
2. Select Enable for the SNMP Agent.
3. Enter a descriptive name for the agent.
4. Enter the location of the FortiGate unit.
5. Enter a contact or administrator for the SNMPAgent or FortiGate unit.
6. Select Apply.

To configure SNMP agent - CLI

config system snmp sysinfo
set status enable
set contact-info <contact_information>
set description <description_of_FortiGate>
set location <FortiGate_location>

end

SNMP community

An SNMP community is a grouping of devices for network administration purposes. Within that SNMP
community, devices can communicate by sending and receiving traps and other information. One device can
belong to multiple communities, such as one administrator terminal monitoring both a firewall SNMP and a
printer SNMP community.

Add SNMP communities to your FortiGate unit so that SNMPmanagers can connect to view system information
and receive SNMP traps.

You can add up to three SNMP communities. Each community can have a different configuration for SNMP
queries and traps. Each community can be configured to monitor the FortiGate unit for a different set of events.
You can also add the IP addresses of up to 8 SNMPmanagers to each community.

When the FortiGate unit is in virtual domain mode, SNMP traps can only be sent on interfaces in the
management virtual domain. Traps cannot be sent over other interfaces.

To add an SNMP v1/v2c community - GUI

1. Go to System > SNMP.
2. In the SNMP v1/v2c area, select Create New.
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3. Enter a Community Name.
4. Enter the IP address and Identify the SNMPmanagers that can use the settings in this SNMP community to

monitor the FortiGate unit.
5. Select the interface if the SNMPmanager is not on the same subnet as the FortiGate unit.
6. Enter the Port number that the SNMPmanagers in this community use for SNMP v1 and SNMP v2c queries to

receive configuration information from the FortiGate unit. Select the Enable check box to activate queries for
each SNMP version.

7. Enter the Local and Remote port numbers that the FortiGate unit uses to send SNMP v1 and SNMP v2c traps to
the SNMPmanagers in this community.

8. Select the Enable check box to activate traps for each SNMP version.
9. Select OK.

To add an SNMP v1/v2c community - CLI

config system snmp community
edit <index_number>

set events <events_list>
set name <community_name>
set query-v1-port <port_number>
set query-v1-status {enable | disable}
set query-v2c-port <port_number>
set query-v2c-status {enable | disable}
set status {enable | disable}
set trap-v1-lport <port_number>
set trap-v1-rport <port_number>
set trap-v1-status {enable | disable}
set trap-v2c-lport <port_number>
set trap-v2c-rport <port_number>
set trap-v2c-status {enable | disable}

end

To add an SNMP v3 community - GUI

1. Go to System > SNMP.
2. In the SNMP v3 area, select Create New.
3. Enter a User Name.
4. Select a Security Level and associated authorization algorithms.
5. Enter the IP address of the Notification Host SNMPmanagers that can use the settings in this SNMP

community to monitor the FortiGate unit.
6. Enter the Port number that the SNMPmanagers in this community use to receive configuration information from

the FortiGate unit. Select the Enable check box to activate queries for each SNMP version.
7. Select the Enable check box to activate traps.
8. Select OK.

To add an SNMP v3 community - CLI

config system snmp user
edit <index_number>

set security-level [auth-priv | auth-no-priv | no-auth-no-priv}
set queries enable
set query-port <port_number>
set notify-hosts <ip_address>
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set events <event_selections>
end

Enabling on the interface

Before a remote SNMPmanager can connect to the FortiGate agent, you must configure one or more FortiGate
interfaces to accept SNMP connections.

To configure SNMP access - GUI

1. Go to Network > Interfaces.
2. Choose an interface that an SNMPmanager connects to and select Edit.
3. In Administrative Access, select SNMP.
4. Select OK.

To configure SNMP access - CLI

config system interface
edit <interface_name>

set allowaccess snmp
end

If the interface you are configuring already has protocols that are allowed access, use
the command append allowaccess snmp instead, or else the other protocols
will be replaced. For more information, see Adding and removing options from lists.

Fortinet MIBs

The FortiGate SNMP agent supports Fortinet proprietary MIBs as well as standard RFC 1213 and RFC 2665
MIBs. RFC support includes support for the parts of RFC 2665 (Ethernet-like MIB) and the parts of RFC 1213
(MIB II) that apply to FortiGate unit configuration.

There are two MIB files for FortiGate units - the Fortinet MIB, and the FortiGate MIB. The Fortinet MIB contains
traps, fields and information that is common to all Fortinet products. The FortiGate MIB contains traps, fields and
information that is specific to FortiGate units. Each Fortinet product has its own MIB. If you use other Fortinet
products you will need to download their MIB files as well. Both MIB files are used for FortiOS and FortiOS
Carrier; there are no additional traps for the Carrier version of the operating system.

The Fortinet MIB and FortiGate MIB along with the two RFCMIBs are listed in tables in this section. You can
download the two FortiGate MIB files from Fortinet Customer Support. The Fortinet MIB contains information for
Fortinet products in general. the Fortinet FortiGate MIB includes the system information for The FortiGate unit
and version of FortiOS. Both files are required for proper SNMP data collection.

To download the MIB files, go to System > SNMP and select a MIB link in the FortiGate SNMP MIB section.

Your SNMPmanager may already include standard and private MIBs in a compiled database that is ready to use.
You must add the Fortinet proprietary MIB to this database to have access to the Fortinet specific information.
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There were major changes to the MIB files between FortiOS Carrier v3.0 and v4.0.
You need to use the new MIBs for FortiOS Carrier v4.0 or you may mistakenly access
the wrong traps and fields.

MIB files are updated for each version of FortiOS. When upgrading the firmware
ensure that you updated the Fortinet FortiGate MIB file as well.

Fortinet MIBs

MIB file name or RFC Description

FORTINET-CORE-MIB.mib The Fortinet MIB includes all system configuration information and trap
information that is common to all Fortinet products.

Your SNMPmanager requires this information to monitor FortiGate unit
configuration settings and receive traps from the FortiGate SNMP agent.

FORTINET-FORTIGATE-
MIB.mib

The FortiGate MIB includes all system configuration information and trap
information that is specific to FortiGate units.

Your SNMPmanager requires this information to monitor FortiGate
configuration settings and receive traps from the FortiGate SNMP agent.
FortiManager systems require this MIB to monitor FortiGate units.

RFC-1213 (MIB II) The FortiGate SNMP agent supports MIB II groups with these exceptions.

•   No support for the EGP group from MIB II (RFC 1213, section 3.11 and
6.10).
•   Protocol statistics returned for MIB II groups (IP/ICMP/TCP/UDP/etc.) do
not accurately capture all FortiGate traffic activity. More accurate
information can be obtained from the information reported by the Fortinet
MIB.

RFC-2665 (Ethernet-like
MIB)

The FortiGate SNMP agent supports Ethernet-like MIB information.
FortiGate SNMP does not support for the dot3Tests and dot3Errors groups.

SNMP improvements for dynamic routing include support for RFC 4750 OSPF Version
2 Management Information Base and RFC 5643 Management Information Base for
OSPFv3. These changes add the capability of logging dynamic routing activity.
Examples include sending OSPF routing events or changes to a syslog server or
FortiAnalyzer or changes in neighborhood status.

Device Detection for SNMP Traps in FortiOS 5.4.0

This setting is related to the device detection feature. It allows SNMP traps to detect when a new device comes
online. Within SNMP configurations there is a configurable timeout setting that periodically checks for the device.
When a check determines that the device is present a trap is sent.

In the GUI, when configuring an SNMP object, one of the settings is a checkbox, under SNMP Events for
Device detected.
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To configure the SNMP object in the CLI use the following syntax:

config system snmp community
edit <community ID number>

set name <string>
set events device-new
end

In order to configure the idle timeout for the device, use the following syntax in the CLI:

config system global
set device-idle-timeout <integer of time in seconds>
end

The time value for the field can be set from 30 to 31536000.

SNMP get command syntax
Normally, to get configuration and status information for a FortiGate unit, an SNMPmanager would use an
SNMP get commands to get the information in a MIB field. The SNMP get command syntax would be similar to:

snmpget -v2c -c <community_name> <address_ipv4> {<OID> | <MIB_field>}

…where…

<community_name> is an SNMP community name added to the FortiGate configuration. You can add more
than one community name to a FortiGate SNMP configuration. The most commonly used community name is
public.

<address_ipv4> is the IP address of the FortiGate interface that the SNMPmanager connects to.

{<OID> | <MIB_field>} is the object identifier (OID) for the MIB field or the MIB field name itself.

The SNMP get command gets firmware version running on the FortiGate unit. The community name is
public. The IP address of the interface configured for SNMPmanagement access is 10.10.10.1. The
firmware version MIB field is fgSysVersion and the OID for this MIB field is
1.3.6.1.4.1.12356.101.4.1.1 The first command uses the MIB field name and the second uses the
OID:

snmpget -v2c -c public 10.10.10.1 fgSysVersion.0
snmpget -v2c -c public 10.10.10.1 1.3.6.1.4.1.12356.101.4.1.1.0

The OIDs and object names used in these examples are dependent on the version of
MIB and are subject to change.

Replacement messages

The replacement message list in System > Replacement Messages enables you to view and customize
replacement messages. Highlight the replacement messages you wish to edit and customize the message
content to your requirements. Hit Savewhen done. If you do not see the message you want to edit, search the
Extended View option (in the upper right-hand corner of the screen).
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Should you make a major error to the code, you can select the Restore Default to return to the original message
and code base.

For connections requiring authentication, the FortiGate unit uses HTTP to send an authentication disclaimer
page for the user to accept before a security policy is in effect. Therefore, the user must initiate HTTP traffic first
in order to trigger the authentication disclaimer page. Once the disclaimer is accepted, the user can send
whatever traffic is allowed by the security policy.

Replacement message images

You can add images to replacement messages to:

l Disclaimer pages
l Login pages
l Declined disclaimer pages
l Login failed page
l Login challenge pages
l Keepalive pages

Image embedding is also available to the endpoint NAC download portal and recommendation portal
replacement messages, as well as HTTP replacement messages.

Supported image formats are GIF, JPEG, TIFF and PNG. The maximum file size supported is 6000 bytes.

Adding images to replacement messages

To upload an image for use in a message

1. Go to System > Replacement Messages.
2. Select Manage Images at the top of the page.
3. Select Create New.
4. Enter a Name for the image.
5. Select the Content Type.
6. Select Browse to locate the file and select OK.
The image that you include in a replacement message, must have the following html:

<img src=%%IMAGE: <config_image_name>%% size=<bytes> >

For example:

<img src=%%IMAGE: logo_hq%% size=4272>

Modifying replacement messages

Replacement messages can be modified to include a message or content that suits your organization.

Use the expand arrows to view the replacement message list for a given category. Messages are in HTML format.
To change a replacement message, go to System > Replacement Messages select the replacement message
that you want to modify. At the bottom pane of the window, you can see the message on one side and the HTML
code on the other side. The message view changes in real-time as you change the content.

A list of common replacement messages appears in the main window. To see the entire list and all categories of
replacement messages, in the upper-right corner of the window, select Extended View.
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Replacement message categories

Alert Email replacement messages

The FortiGate unit adds the replacement messages listed in this category to alert email messages sent to
administrators. If you enable the option Send alert email for logs based on severity in Log & Report, you
control whether or not replacement messages are sent by alert email based on how you set theMinimum log
level.

For more information on Alert emails, see the Monitoring chapter.

Authentication replacement messages

The FortiGate unit uses the text of the authentication replacement messages for various user authentication
HTML pages that are displayed when a user is required to authenticate because a security policy includes at least
one identity-based policy that requires firewall users to authenticate.

These replacement message pages are for authentication using HTTP and HTTPS. You cannot customize the
firewall authentication messages for FTP and Telnet.

The authentication login page and the authentication disclaimer include replacement tags and controls not found
on other replacement messages.

Users see the authentication login page when they use a VPN or a security policy that requires authentication.
You can customize this page in the same way as you modify other replacement messages.

There are some unique requirements for these replacement messages:

l The login page must be an HTML page containing a form with ACTION="/" and METHOD="POST"
l The form must contain the following hidden controls:

l <INPUT TYPE="hidden" NAME="%%MAGICID%%" VALUE="%%MAGICVAL%%">

l <INPUT TYPE="hidden" NAME="%%STATEID%%" VALUE="%%STATEVAL%%">

l <INPUT TYPE="hidden" NAME="%%REDIRID%%" VALUE="%%PROTURI%%">

l The form must contain the following visible controls:
l <INPUT TYPE="text" NAME="%%USERNAMEID%%" size=25>

l <INPUT TYPE="password" NAME="%%PASSWORDID%%" size=25>

Example

The following is an example of a simple authentication page that meets the requirements listed above.

<HTML><HEAD><TITLE>Firewall Authentication</TITLE></HEAD>
<BODY><H4>You must authenticate to use this service.</H4>

<FORM ACTION="/" method="post">
<INPUT NAME="%%MAGICID%%" VALUE="%%MAGICVAL%%" TYPE="hidden">

<TABLE ALIGN="center" BGCOLOR="#00cccc" BORDER="0"
CELLPADDING="15" CELLSPACING="0" WIDTH="320"><TBODY>

<TR><TH>Username:</TH>
<TD><INPUT NAME="%%USERNAMEID%%" SIZE="25" TYPE="text"> </TD></TR>

<TR><TH>Password:</TH>
<TD><INPUT NAME="%%PASSWORDID%%" SIZE="25" TYPE="password"> </TD></TR>

<TR><TD COLSPAN="2" ALIGN="center" BGCOLOR="#00cccc">
<INPUT NAME="%%STATEID%%" VALUE="%%STATEVAL%%" TYPE="hidden">

<INPUT NAME="%%REDIRID%%" VALUE="%%PROTURI%%" TYPE="hidden">
<INPUT VALUE="Continue" TYPE="submit"> </TD></TR>
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</TBODY></TABLE></FORM></BODY></HTML>

Captive Portal Default replacement messages

The Captive Portal Default replacement messages are used for wireless authentication only. You must have a
VAP interface with the security set as captive portal to trigger these replacement messages.

Device Detection Portal replacement message

The FortiGate unit displays the replacement message when the FortiGate unit cannot determine the type of
BYOD or handheld device is used to connect the network.

Email replacement messages

The FortiGate unit sends the mail replacement messages to email clients using IMAP, POP3, or SMTPwhen an
event occurs such as antivirus blocking a file attached to an email that contains a virus. Email replacement
messages are text messages.

If the FortiGate unit supports SSL content scanning and inspection these replacement messages can also be
added to IMAPS, POP3S, and SMTPS email messages.

Endpoint Control replacement message

The FortiGate unit displays the replacement message when the FortiClient Endpoint Security software is not
installed or registered correctly with the FortiGate unit.

FortiGuard Web Filtering replacement messages

The FortiGate unit sends the FortiGuard Web Filtering replacement messages to web browsers using the HTTP
protocol when FortiGuard web filtering blocks a URL, provides details about blocked HTTP 4xx and 5xx errors,
and for FortiGuard overrides. FortiGuard Web Filtering replacement messages are HTTP pages.

If the FortiGate unit supports SSL content scanning and inspection and if Protocol Recognition > HTTPS
Content Filtering Mode is set to Deep Scan in the antivirus profile, these replacement messages can also
replace web pages downloaded using the HTTPS protocol.

FTP replacement messages

The FortiGate unit sends the FTP replacement messages listed in the table below to FTP clients when an event
occurs such as antivirus blocking a file that contains a virus in an FTP session. FTP replacement messages are
text messages.

HTTP replacement messages

The FortiGate unit sends the HTTP replacement messages listed in the following table to web browsers using the
HTTP protocol when an event occurs such as antivirus blocking a file that contains a virus in an HTTP session.
HTTP replacement messages are HTML pages.

If the FortiGate unit supports SSL content scanning and inspection, and if under HTTPS in the protocol option list
has Enable Deep Scan enabled, these replacement messages can also replace web pages downloaded using the
HTTPS protocol.
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NNTP replacement messages

The FortiGate unit sends the NNTP replacement messages NNTP clients when an event occurs such as antivirus
blocking a file attached to an NNTPmessage that contains a virus. NNTP replacement messages are text
messages.

Spam replacement messages

The FortiGate unit adds the Spam replacement messages to SMTP server responses if the email message is
identified as spam and the spam action is discard. If the FortiGate unit supports SSL content scanning and
inspection these replacement messages can also be added to SMTPS server responses.

NAC quarantine replacement messages

The page that is displayed for the user depends on whether NAC quarantine blocked the user because a virus was
found, a DoS sensor detected an attack, an IPS sensor detected an attack, or a DLP rule with action set to
Quarantine IP address orQuarantine Interfacematched a session from the user.

The default messages inform the user of why they are seeing this page and recommend they contact the system
administrator. You can customize the pages as required, for example to include an email address or other contact
information or if applicable a note about how long the user can expect to be blocked.

SSL VPN replacement messages

The SSL VPN login replacement message is an HTML replacement message that formats the FortiGate SSL
VPN portal login page. You can customize this replacement message according to your organization’s needs. The
page is linked to FortiGate functionality and you must construct it according to the following guidelines to ensure
that it will work.

l The login page must be an HTML page containing a form with ACTION="%%SSL_ACT%%" and
METHOD="%%SSL_METHOD%%"

l The form must contain the %%SSL_LOGIN%% tag to provide the login form.
l The form must contain the %%SSL_HIDDEN%% tag.

Web Proxy replacement messages

The FortiGate unit sendsWeb Proxy replacement messages when a web proxy event occurs that is detected and
matches the web proxy configuration. These replacement messages are web pages that appear within your web
browser.

The following web proxy replacement messages require an identity-based security policy so that the web proxy is
successful. You can also enable FTP-over-HTTP by selecting the FTP option in System > Network > Explicit
Proxy.

Traffic quota control replacement messages

When user traffic is going through the FortiGate unit and it is blocked by traffic shaping quota controls, users see
the Traffic shaper block message or the Per IP traffic shaper block messagewhen they attempt to
connect through the FortiGate unit using HTTP.

The traffic quota HTTP pages should contain the %%QUOTA_INFO%% tag to display information about the traffic
shaping quota setting that is blocking the user.
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MM1 replacement messages

MM1 replacement messages are sent when, during MMS content scanning, FortiOS Carrier detects, for example
a virus, using the MMS profile.

You must have Remove Blocked selected within the MMS profile if you want to remove the content that is
intercepted during MMS scanning on the FortiGate unit.

MM3 replacement messages

MM3 replacement messages are sent when, during MMS content scanning, FortiOS Carrier detects, for example
a virus, using the MMS profile.

You must have Remove Blocked selected within the MMS profile if you want to remove the content that is
intercepted during MMS scanning on the unit.

MM4 replacement messages

MM4 replacement messages are sent when, during MMS content scanning, FortiOS Carrier detects, for example
a virus, using the MMS profile.

MM7 replacement messages

MM7 replacement messages are sent when, during MMS content scanning, FortiOS Carrier detects, for example
a virus, using the MMS profile.

MMS replacement messages

The MMS replacement message is sent when a section of an MMSmessage has been replaced because it
contains a blocked file. This replacement message is in HTML format.

The message text is:

<HTML><BODY>This section of the message has been replaced because it contained a blocked
file</BODY></HTML>

Replacement message groups

Replacement message groups enable you to view common messages in groups for large carriers. Message
groups can be configured by going to Config > Replacement Message Group.

Using the defined groups, you can manage specific replacement messages from a single location, rather than
searching through the entire replacement message list.

If you enable virtual domains (VDOMs) on the FortiGate unit, replacement message groups are configured
separately for each virtual domain. Each virtual domain has its own default replacement message group,
configured from System > Replacement Messages Group.

When you modify a message in a replacement message group, a Reset icon appears beside the message in the
group. You can select this Reset icon to reset the message in the replacement message group to the default
version.

All MM1/4/7 notification messages for FortiOS Carrier (and MM1 retrieve-conf messages) can contain a SMIL
layer and all MM4 notification messages can contain an HTML layer in the message. These layers can be used to
brand messages by using logos uploaded to the FortiGate unit via the 'Manage Images' link found on the
replacement message group configuration page.
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Administration for schools

For system administrator in the school system it is particularly difficult to maintain a network and access to the
Internet. There are potential legal liabilities if content is not properly filtered and children are allowed to view
pornography and other non-productive and potentially dangerous content. For a school, too much filtering is
better than too little. This section describes some basic practices administrators can employ to help maintain
control without being too draconian for access to the internet.

Security policies

The default security policies in FortiOS allow all traffic on all ports and all IP addresses. Not the most secure.
While applying UTM profiles can help to block viruses, detect attacks and prevent spam, this doesn’t provide a
solid overall security option. The best approach is a layered approach; the first layer being the security policy.

When creating outbound security policies, you need to know the answer to the question “What are the students
allowed to do?” The answer is surf the web, connect to FTP sites, send/receive email, and so on.

Once you know what the students need to do, you can research the software used and determine the ports the
applications use. For example, if the students only require web surfing, then there are only two ports (80 - HTTP
and 443 - HTTPS) needed to complete their tasks. Setting the security policies to only allow traffic through two
ports (rather than all 65,000), this will significantly lower any possible exploits. By restricting the ports to known
services, means stopping the use of proxy servers, as many of them operate on a non-standard port to hide their
traffic from URL filtering or HTTP inspection.

DNS

Students should not be allowed to use whatever DNS they want. this opens another port for them to use and
potentially smuggle traffic on. The best approach is to point to an internal DNS server and only allow those
devices out on port 53. Its the same approach one would use for SMTP. Only allow the mail server to use port 25
since nothing else should be sending email.

If there is no internal DNS server, then the list of allowed DNS servers they can use should be restrictive. One
possible exploit would be for them to set up their own DNS server at home that serves different IPs for known
hosts, such as having Google.com sent back the IP for playboy.com.

Encrypted traffic (HTTPS)

Generally speaking, students should not be allowed to access encrypted web sites. Encrypted traffic cannot be
sniffed, and therefore, cannot be monitored. HTTPS traffic should only be allowed when necessary. Most web
sites a student needs to access are HTTP, not HTTPS. Due to the nature of HTTPS protocol, and the fact that
encryption is an inherent security risk to your network, its use should be restricted.

Adding a security policy that encompasses a list of allowed secure sites will ensure that any HTTPS sites that are
required are the only sites a student can go to.

FTP

For the most part, students should not be using FTP. FTP is not HTTP or HTTPS so you cannot use URL filtering
to restrict where they go. This can be controlled with destination IPs in the security policy. With a policy that
specifically outlines which FTP addresses are allowed, all other will be blocked.
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Example security policies

Given these requirements, an example set of security policies could look like the following illustration. In a large
setup, all the IPs for the students are treated by one of these four policies.

Simple security policy setup

The last policy in the list, included by default, is a deny policy. This adds to the potential of error that could end up
allowing unwanted traffic to pass. The deny policy ensures that an y traffic making it to this point is stopped. It
can also help in further troubleshooting by viewing the logs for denied traffic.

With these policies in place, even before packet inspection occurs, the FortiGate, and the network are fairly
secure. Should any of the UTM profiles fail, there is still a basic level of security.

UTM security profiles

AntiVirus profiles

Antivirus screening should be enabled for any service you have enabled in the security policies. In the case above,
HTTP, FTP, as well as POP3 and SMTP (assuming there is email access for students). There is not a virus scan
option for HTTPS, because the content is encrypted. Generally speaking, most of the network traffic will be
students surfing the web.

To configure antivirus profiles in the web-based manager, go to Security Profiles > AntiVirus, or use the CLI
commands under config antivirus profile.

Web filtering

The actual filtering of URLs, sites and content, should be performed by FortiGuard. It is easier for the network
administrator. Web sites are constantly being monitored, and new ones reviewed and added to the FortiGuard
databases every day. The FortiGuard categories provide an extensive list of offensive and non-productive sites.

As well, there are additional settings to include in a web filtering profile to best contain a student’s web browsing.

l Web URL filtering should be enabled to set up exemptions for web sites that are blocked or reasons other than
category filtering. It also prevents the use of IP addresses to get around web filtering.

l Block invalid URLs - HTTPS only. This option inspects the HTTPS certificate and looks at the URL to ensure it’s
valid. It is common for proxy sites to create an HTTPS certificate with a garbage URL. If the site is legitimate, it
should be set up correctly. If the site approach to security is to ignore it, then their security policy puts your network
at risk and the site should be blocked.

l Enable Block malicious URLs discovered by FortiSandbox. If the FortiSandbox discovers a threat, the
source URL will be added to the list of URLs to be blocked by the FortiGate.

Web filtering options are configured in the GUI by going to Security Profiles > Web Filter, or in the CLI under
config webfilter profile.
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Categories and Classifications

For the selection of what FortiGuard categories and classifications that should be blocked, that is purely based on
the school system and its Internet information policy.

Email Filtering

Other than specific teacher-led email inboxes, there is no reason why a student should be able to access, read or
send personal email. Ports for POP3, SMTP and IMAP should not be opened in a security policies.

IPS

The intrusion protection profiles should be used to ensure the student PCs are not vulnerable to attacks, nor do
you want students making attacks. As well, IPS can do more than simple vulnerability scans. With a FortiGuard
subscription, IPS signatures are pushed to the FortiGate unit. New signatures are released constantly for various
intrusions as they are discovered.

FortiOS includes a number of predefined IPS sensors that you can enable by default. Selecting the all_default
signature is a good place to start as it includes the major signatures.

To configure IPS sensors in the GUI, go to Security Profiles > Intrusion Protection, on the CLI use
commands under config ips sensor.

Application control

Application control uses IPS signatures to limit the use of instant messaging and peer-to-peer applications which
can lead to possible infections on a student’s PC. FortiOS includes a number of pre-defined application
categories. To configure and maintain application control profiles in the GUI, go to Security Profiles >
Application Control. In the CLI use commands under config application list.

Some applications to consider include proxies, botnets, toolbars and P2P applications.

Logging

Turn on all logging. Every option in this section should be enabled. This is not where you decide what you are
going to log. It is simply defining what the UTM profiles can log.

Logging everything is a way to monitor traffic on the network, see what student’s are utilizing the most, and locate
any potential holes in your security plan. As well, keeping this information may help to prove negligence later in
necessary.
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A virtual private network (VPN) is a way to use a public network, such as the Internet, as a vehicle to provide
remote offices or individual users with secure access to private networks. FortiOS supports the Point-to-Point
Tunneling Protocol (PPTP), which enables interoperability between FortiGate units and Windows or Linux PPTP
clients. Because FortiGate units support industry standard PPTP VPN technologies, you can configure a PPTP
VPN between a FortiGate unit and most third-party PPTP VPN peers.

This section describes how to configure PPTP and L2TP VPNs as well as PPTP passthrough.

This section includes the topics:

l How PPTP VPNs work
l FortiGate unit as a PPTP server
l Configuring the FortiGate unit for PPTP VPN
l Configuring the FortiGate unit for PPTP pass through
l Testing PPTP VPN connections
l Logging VPN events
l Configuring L2TP VPNs
l L2TP configuration overview

How PPTP VPNs work
The Point-to-Point Tunneling Protocol enables you to create a VPN between a remote client and your internal
network. Because it is a Microsoft Windows standard, PPTP does not require third-party software on the client
computer. As long as the ISP supports PPTP on its servers, you can create a secure connection by making
relatively simple configuration changes to the client computer and the FortiGate unit.

PPTP uses Point-to-Point protocol (PPP) authentication protocols so that standard PPP software can operate on
tunneled PPP links. PPTP packages data in PPP packets and then encapsulates the PPP packets within IP
packets for transmission through a VPN tunnel.

When the FortiGate unit acts as a PPTP server, a PPTP session and tunnel is created as soon as the PPTP client
connects to the FortiGate unit. More than one PPTP session can be supported on the same tunnel. FortiGate
units support PAP, CHAP, and plain text authentication. PPTP clients are authenticated as members of a user
group.

Traffic from one PPTP peer is encrypted using PPP before it is encapsulated using Generic Routing
Encapsulation (GRE) and routed to the other PPTP peer through an ISP network. PPP packets from the remote
client are addressed to a computer on the private network behind the FortiGate unit. PPTP packets from the
remote client are addressed to the public interface of the FortiGate unit. Seethe figure below.
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PPTP control channel messages are not authenticated, and their integrity is not
protected. Furthermore, encapsulated PPP packets are not cryptographically
protected and may be read or modified unless appropriate encryption software such as
Secure Shell (SSH) or Secure File Transfer Protocol (SFTP) is used to transfer data
after the tunnel has been established.

As an alternative, you can use encryption software such as Microsoft Point-to-Point
Encryption (MPPE) to secure the channel. MPPE is built into Microsoft Windows
clients and can be installed on Linux clients. FortiGate units support MPPE.

Packet encapsulation

Shown above, traffic from the remote client is addressed to a computer on the network behind the FortiGate unit.
When the PPTP tunnel is established, packets from the remote client are encapsulated and addressed to the
FortiGate unit. The FortiGate unit forwards disassembled packets to the computer on the internal network.

When the remote PPTP client connects, the FortiGate unit assigns an IP address from a reserved range of IP
addresses to the client PPTP interface. The PPTP client uses the assigned IP address as its source address for
the duration of the connection.

When the FortiGate unit receives a PPTP packet, the unit disassembles the PPTP packet and forwards the
packet to the correct computer on the internal network. The security policy and protection profiles on the
FortiGate unit ensure that inbound traffic is screened and processed securely.

PPTP clients must be authenticated before a tunnel is established. The authentication
process relies on FortiGate user group definitions, which can optionally use
established authentication mechanisms such as RADIUS or LDAP to authenticate
PPTP clients. All PPTP clients are challenged when a connection attempt is made.

3138 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 28 - System Administration PPTP and L2TP

FortiGate unit as a PPTP server
In the most common Internet scenario, the PPTP client connects to an ISP that offers PPP connections with
dynamically-assigned IP addresses. The ISP forwards PPTP packets to the Internet, where they are routed to the
FortiGate unit.

FortiGate unit as a PPTP server

If the FortiGate unit will act as a PPTP server, there are a number of steps to complete:

l Configure user authentication for PPTP clients.
l Enable PPTP.
l Specify the range of addresses that are assigned to PPTP clients when connecting
l Configure the security policy.

Configuring user authentication for PPTP clients

To enable authentication for PPTP clients, you must create user accounts and a user group to identify the PPTP
clients that need access to the network behind the FortiGate unit. Within the user group, you must add a user for
each PPTP client.

You can choose to use a plain text password for authentication or forward authentication requests to an external
RADIUS, LDAP, or TACACS+ server. If password protection will be provided through a RADIUS, LDAP, or
TACACS+ server, you must configure the FortiGate unit to forward authentication requests to the authentication
server.

This example creates a basic user/password combination.
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Configuring a user account

To add a local user - GUI

1. Go to User & Device > User Definition and select Create New.
2. Select Local User
3. Enter a User Name.
4. Enter a Password for the user. The password should be at least six characters.
5. Select OK.

To add a local user - CLI

config user local
edit <username>

set type password
set passwd <password>

end

Configuring a user group

To ease configuration, create user groups that contain users in similar categories or departments.

To create a user group - GUI

1. Go to User & Device > User Group and select Create New.
2. Enter a Name for the group.
3. Select the Type of Firewall.
4. From the Available Users list, select the required users and select the right-facing arrow to add them to the

Members list.
5. Select OK.

To create a user group - CLI

config user group
edit <group_name>

set group-type firewall
set member <user_names>

end

Enabling PPTP and specifying the PPTP IP address range

The PPTP address range specifies the range of addresses reserved for remote PPTP clients. When a PPTP client
connects to the FortiGate unit, the client is assigned an IP address from this range. Afterward, the FortiGate unit
uses the assigned address to communicate with the PPTP client.

The address range that you reserve can be associated with private or routable IP addresses. If you specify a
private address range that matches a network behind the FortiGate unit, the assigned address will make the
PPTP client appear to be part of the internal network.

PPTP requires two IP addresses, one for each end of the tunnel. The PPTP address range is the range of
addresses reserved for remote PPTP clients. When the remote PPTP client establishes a connection, the
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FortiGate unit assigns an IP address from the reserved range of IP addresses to the client PPTP interface or
retrieves the assigned IP address from the PPTP user group. If you use the PPTP user group, you must also
define the FortiGate end of the tunnel by entering the IP address of the unit in Local IP (web-based manager) or
local-ip (CLI). The PPTP client uses the assigned IP address as its source address for the duration of the
connection.

PPTP configuration is only available through the CLI. In the example below, PPTP is enabled with the use of an
IP range of 192.168.1.1 to 192.168.1.10 for addressing and the user group is hr_staff.

FortiOS 5.4.0 and later versions allow the start and end IPs in the PPTP
address range to be in the same 16-bit subnet. Earlier versions require that
the start and end IPs in the PPTP address range be in the same 24-bit
subnet, for example, 192.168.1.1 - 192.168.1.254. .

config vpn pptp
set status enable
set ip-mode range
set eip 192.168.1.10
set sip 192.168.1.1
set usrgrp hr_staff

end

In this example, PPTP is enabled with the use of a user group for addressing, where the IP address of the PPTP
server is 192.168.1.2 and the user group is hr_admin.

config vpn pptp
set status enable
set ip-mode range
set local-ip 192.168.2.1
set usrgrp hr_admin

end

Adding the security policy

The security policy specifies the source and destination addresses that can generate traffic inside the PPTP
tunnel and defines the scope of services permitted through the tunnel. If a selection of services are required,
define a service group.

To configure the firewall for the PPTP tunnel - GUI

1. Go to Policy & Objects > IPv4 or Policy & Objects > IPv6 and select Create New.
2. Complete the following and select OK:

Incoming Interface The FortiGate interface connected to the Internet.

Source Address Select the name that corresponds to the range of addresses that you
reserved for PPTP clients.

Outgoing Interface The FortiGate interface connected to the internal network.

Destination Address Select the name that corresponds to the IP addresses behind the FortiGate
unit.
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Schedule always

Service ALL

Action ACCEPT

To configure the firewall for the PPTP tunnel - CLI

config firewall policy or config firewall policy6
edit 1

set srcintf <interface to internet>
set dstintf <interface to internal network>
set srcaddr <reserved_range>
set dstaddr <internal_addresses>
set action accept
set schedule always
set service ALL

end

Configuring the FortiGate unit for PPTP VPN
To arrange for PPTP packets to pass through the FortiGate unit to an external PPTP server, perform the following
tasks in the order given:

l Configure user authentication for PPTP clients.
l Enable PPTP on the FortiGate unit and specify the range of addresses that can be assigned to PPTP clients when

they connect.
l Configure PPTP pass through on the FortiGate unit.

Configuring the FortiGate unit for PPTP passthrough
To forward PPTP packets to a PPTP server on the network behind the FortiGate unit, you need to perform the
following configuration tasks on the FortiGate unit:

l Define a virtual IP address that points to the PPTP server.
l Create a security policy that allows incoming PPTP packets to pass through to the PPTP server.

The address range is the external (public) ip address range which requires access to
the internal PPTP server through the FortiGate virtual port-forwarding firewall.

IP addresses used in this document are fictional and follow the technical
documentation guidelines specific to Fortinet. Real external IP addresses are not
used.

Configuring a virtual IP address

The virtual IP address will be the address of the PPTP server host.

To define a virtual IP for PPTP passthrough - GUI

1. Go to Policy & Objects > Virtual IPs.
2. Select Create New.
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3. Choose the VIP Type.
4. Enter the name of the VIP, for example, PPTP_Server.
5. Select the External Interfacewhere the packets will be received for the PPTP server.
6. Enter the External IP Address for the VIP.
7. Select Port Forwarding.
8. Set the Protocol to TCP.
9. Enter the External Service Port of 1723, the default for PPTP.
10. Enter theMap to Port to 1723.
11. Select OK.

To define a virtual IP for PPTP passthrough - CLI

config firewall vip or config firewall vip6
edit PPTP_Server

set extintf <interface>
set extip <ip_address>
set portforward enable
set protocol tcp
set extport 1723
set mappedport 1723
set mappedip <destination IP address range>
end

You can also use config firewall vip46 to define a virtual IP from an IPv4 address to an IPv6 address or
config firewall vip64 to define a virtual IP from an IPv6 address to an IPv4 address.

Configuring a port-forwarding security policy

To create a port-forwarding security policy for PPTP passthrough you must first create an address range reserved
for the PPTP clients.

To create an address range - GUI

1. Go to Policy & Objects > Addresses and select Create New.
2. Select a Category.
3. Enter a Name for the range, for example, External_PPTP.
4. Select a Type of Subnet/IP Range.
5. Enter the IP address range.
6. Select the Interface to the Internet.
7. Select OK.

To create an address range - CLI

config firewall address OR config firewall address6
edit External_PPTP

set type ip_range
set start-ip <ip_address>
set end-ip <ip_address>
set associated-interface <internet_interface>

end
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With the address set, you can add the security policy.

To add the security policy - GUI

1. Go to Policy & Objects > IPv4 or Policy & Objects > IPv6 and select Create New.
2. Complete the following and select OK:

Incoming Interface The FortiGate interface connected to the Internet.

Source Address Select the address range created in the previous step.

Outgoing Interface The FortiGate interface connected to the PPTP server.

Destination Address Select the VIP address created in the previous steps.

Schedule always

Service PPTP

Action ACCEPT

To add the security policy - CLI

config firewall policy or config firewall policy6
edit <policy_number>

set srcintf <interface to internet>
set dstintf <interface to PPTP server>
set srcaddr <address_range>
set dstaddr <PPTP_server_address>
set action accept
set schedule always
set service PPTP

end

Testing PPTP VPN connections
To confirm that a PPTP VPN between a local network and a dialup client has been configured correctly, at the
dialup client, issue a ping command to test the connection to the local network. The PPTP VPN tunnel initializes
when the dialup client attempts to connect.

Logging VPN events
PPTP VPN, activity is logged when enabling VPN logging. The FortiGate unit connection events and tunnel status
(up/down) are logged.

To log VPN events

1. Go to Log & Report > Log Settings.
2. Enable Event Logging.
3. Select VPN activity event.
4. Select Apply.
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To view event logs

1. Go to Log & Report > VPN Events.
2. If the option is available to set the log location list, select disk or memory.
3. Select a log event and select Details.

Configuring L2TP VPNs
This section describes how to configure a FortiGate unit to establish a Layer Two Tunneling Protocol (L2TP)
tunnel with a remote dialup client. The FortiGate implementation of L2TP enables a remote dialup client to
establish an L2TP tunnel with the FortiGate unit directly.

According to RFC 2661, an Access Concentrator (LAC) can establish an L2TP tunnel with an L2TP Network
Server (LNS). In a typical scenario, the LAC is managed by an ISP and located on the ISP premises; the LNS is
the gateway to a private network. When a remote dialup client connects to the Internet through the ISP, the ISP
uses a local database to establish the identity of the caller and determine whether the caller needs access to an
LNS through an L2TP tunnel. If the services registered to the caller indicate that an L2TP connection to the LNS
is required, the ISP LAC attempts to establish an L2TP tunnel with the LNS.

A FortiGate unit can be configured to act as an LNS. The FortiGate implementation of L2TP enables a remote
dialup client to establish an L2TP tunnel with the FortiGate unit directly, bypassing any LAC managed by an ISP.
The ISPmust configure its network access server to forward L2TP traffic from the remote client to the FortiGate
unit directly whenever the remote client requires an L2TP connection to the FortiGate unit.

When the FortiGate unit acts as an LNS, an L2TP session and tunnel is created as soon as the remote client
connects to the FortiGate unit. The FortiGate unit assigns an IP address to the client from a reserved range of IP
addresses. The remote client uses the assigned IP address as its source address for the duration of the
connection.

More than one L2TP session can be supported on the same tunnel. FortiGate units can be configured to
authenticate remote clients using a plain text user name and password, or authentication can be forwarded to an
external RADIUS or LDAP server. L2TP clients are authenticated as members of a user group.

For site-to-site connections, Windows servers use IPsec encryption when you
configure the VPN to connect to an L2TP server.

Traffic from the remote client must be encrypted using IPsec before it is encapsulated and routed to the
FortiGate unit. Packets originating at the remote client are addressed to a computer on the private network
behind the FortiGate unit. Encapsulated packets are addressed to the public interface of the FortiGate unit. See
the figure below.

When the FortiGate unit receives an L2TP packet, the unit disassembles the packet and forwards the packet to
the correct computer on the internal network. The security policy and protection profiles on the FortiGate unit
ensure that inbound traffic is screened and processed securely.
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L2TP encapsulation

FortiGate units cannot deliver non-IP traffic such as Frame Relay or ATM frames encapsulated in L2TP packets
— FortiGate units support the IPv4 and IPv6 addressing schemes only

Network topology

The remote client connects to an ISP that determines whether the client requires an L2TP connection to the
FortiGate unit. If an L2TP connection is required, the connection request is forwarded to the FortiGate unit
directly.
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Example L2TP configuration

L2TP infrastructure requirements

l The FortiGate unit must be operating in NAT mode and have a static public IP address.
l The ISPmust configure its network access server to forward L2TP traffic from remote clients to the FortiGate unit

directly.
l The remote client must not generate non-IP traffic (Frame Relay or ATM frames).

L2TP configuration overview
To configure a FortiGate unit to act as an LNS, you perform the following tasks:

l Create an L2TP user group containing one user for each remote client.
l Enable L2TP on the FortiGate unit and specify the range of addresses that can be assigned to remote clients when

they connect.
l Define firewall source and destination addresses to indicate where packets transported through the L2TP tunnel will

originate and be delivered.
l Create the security policy and define the scope of permitted services between the source and destination

addresses.
l Configure the remote clients.

Authenticating L2TP clients

L2TP clients must be authenticated before a tunnel is established. The authentication process relies on FortiGate
user group definitions, which can optionally use established authentication mechanisms such as RADIUS or
LDAP to authenticate L2TP clients. All L2TP clients are challenged when a connection attempt is made.
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To enable authentication, you must create user accounts and a user group to identify the L2TP clients that need
access to the network behind the FortiGate unit.

You can choose to use a plain text password for authentication or forward authentication requests to an external
RADIUS or LDAP server. If password protection will be provided through a RADIUS or LDAP server, you must
configure the FortiGate unit to forward authentication requests to the authentication server.

Enabling L2TP and specifying an address range

The L2TP address range specifies the range of addresses reserved for remote clients. When a remote client
connects to the FortiGate unit, the client is assigned an IP address from this range. Afterward, the FortiGate unit
uses the assigned address to communicate with the remote client.

The address range that you reserve can be associated with private or routable IP addresses. If you specify a
private address range that matches a network behind the FortiGate unit, the assigned address will make the
remote client appear to be part of the internal network.

To enable L2TP and specify the L2TP address range, use the config vpn l2tp CLI command.

The following example shows how to enable L2TP and set the L2TP address range using a starting address of
192.168.10.80 and an ending address of 192.168.10.100 for an existing group of L2TP users named
L2TP_users:

config vpn l2tp
set sip 192.168.10.80
set eip 192.168.10.100
set status enable
set usrgrp L2TP_users

end

Defining firewall source and destination addresses

Before you define the security policy, you must define the source and destination addresses of packets that are to
be transported through the L2TP tunnel:

l For the source address, enter the range of addresses that you reserved for remote L2TP clients (for example
192.168.10.[80-100]).

l For the destination address, enter the IP addresses of the computers that the L2TP clients need to access on the
private network behind the FortiGate unit (for example, 172.16.5.0/24 for a subnet, or 172.16.5.1 for a
server or host, or 192.168.10.[10-15] for an IP address range).

To define the firewall source address

1. Go to Policy & Objects > Addresses and select Create New.
2. Select Address.
3. In the Name field, type a name that represents the range of addresses that you reserved for remote clients (for

example, Ext_L2TPrange).
4. In Type, select IP Range.
5. In the Subnet / IP Range field, type the corresponding IP address range.
6. In Interface, select the FortiGate interface that connects to the clients.
7. This is usually the interface that connects to the Internet.
8. Select OK.
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To define the firewall destination address

1. Go to Policy & Objects > Addresses and select Create New.
2. In the Address Name field, type a name that represents a range of IP addresses on the network behind the

FortiGate unit (for example, Int_L2TPaccess).
3. In Type, select IP Range.
4. In the IP Range field, type the corresponding IP address range.
5. In Interface, select the FortiGate interface that connects to the network behind the FortiGate unit.
6. Select OK.

Adding the security policy

The security policy specifies the source and destination addresses that can generate traffic inside the L2TP
tunnel and defines the scope of services permitted through the tunnel. If a selection of services are required,
define a service group.

To define the traffic and services permitted inside the L2TP tunnel

1. Go to Policy & Objects > IPv4 or Policy & Objects > IPv6 and select Create New.
2. Enter these settings:

Name Input a name for the policy.

Incoming Interface Select the FortiGate interface to the Internet.

Outgoing Interface Select the FortiGate interface to the internal (private) network.

Source Address Select the name that corresponds to the address range that reserved for
L2TP clients (for example, Ext_L2TPrange).

Destination Address Select the name that corresponds to the IP addresses behind the FortiGate
unit (for example, Int_L2TPaccess).

Schedule Select ALWAYS, or if a select schedule is required instead, select a
schedule that you defined previously.

Service Select ALL, or if selected services are required instead, select the service
group that you defined previously.

Action ACCEPT

3. Select OK.

Configuring a Linux client

This procedure outlines how to install L2TP client software and run an L2TP tunnel on a Linux computer. Obtain
an L2TP client package that meets your requirements (for example, rp-l2tp). If needed to encrypt traffic,
obtain L2TP client software that supports encryption using IPsec.

To establish an L2TP tunnel with a FortiGate unit that has been set up to accept L2TP connections, you can
obtain and install the client software following these guidelines:

1. If encryption is required, you will need to verify the IPsec configuration.
2. Download and install the L2TP client package.
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3. Configure an L2TP connection to run the L2TP program.
4. Configure routes to determine whether all or some of your network traffic will be sent through the tunnel. You must

define a route to the remote network over the L2TP link and a host route to the FortiGate unit.
5. Run l2tpd to start the tunnel.
Follow the software supplier’s documentation to complete the steps.

To configure the system, you need to know the public IP address of the FortiGate unit, and the user name and
password that has been set up on the FortiGate unit to authenticate L2TP clients. Contact the FortiGate
administrator if required to obtain this information.

Monitoring L2TP sessions

You can display a list of all active sessions and view activity by port number. By default, port 1701 is used for
L2TP VPN-related communications. If required, active sessions can be stopped from this view. Use FortiView >
All Sessions.

Testing L2TP VPN connections

To confirm that a VPN between a local network and a dialup client has been configured correctly, at the dialup
client, issue a ping command to test the connection to the local network. The VPN tunnel initializes when the
dialup client attempts to connect.

Logging L2TP VPN events

You can configure the FortiGate unit to log VPN events. For L2TP VPNs, connection events and tunnel status
(up/down) are logged.

To log VPN events - GUI

1. Go to Log & Report > Log Settings.
2. Enable the storage of log messages to one or more locations.
3. Select Enable, and then select VPN activity event.
4. Select Apply.

To log VPN events - CLI

config log memory setting
set diskfull overwrite
set status enable

end
config log eventfilter

set vpn enable
end
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FortiOS uses session helpers to process sessions that have special requirements. Session helpers function like
proxies by getting information from the session and performing support functions required by the session. For
example:

l The SIP session helper looks inside SIPmessages and performs NAT (if required) on the IP addresses in the SIP
message and opens pinholes to allow media traffic associated with the SIP session to pass through the FortiGate
unit.

l The FTP session helper can keep track of multiple connections initiated from a single FTP session. The session
helper also permits an FTP server to actively open a connection back to a client program.

l The TNS session helper sniffs the return packet from an initial 1521 SQLNET exchange and then uses the port and
session information uncovered in that return TNS redirect packet to add a temporary firewall policy that accepts the
new port and IP address supplied as part of the TNS redirect.

The session helper configuration binds a session helper to a TCP or UDP port and protocol. When a session is
accepted by a firewall policy on that port and protocol the FortiOS passes the session to the session helper
configured with this command. The session is processed by the session helper.

If your FortiGate accepts sessions that require a session helper on different ports than those defined by the
session-helper configuration, then you can add more entries to the session helper configuration. You can have
multiple session helper configurations for a given protocol because only the matching configuration is used.

Use the show system session-helper command to view the current session helper configuration.

This section includes the topics:

l Viewing the session helper configuration
l Changing the session helper configuration
l DCE-RPC session helper (dcerpc)
l DNS session helpers (dns-tcp and dns-udp)
l File transfer protocol (FTP) session helper (ftp)
l H.323 and RAS session helpers (h323 and ras)
l Media Gateway Controller Protocol (MGCP) session helper (mgcp)
l ONC-RPC portmapper session helper (pmap)
l PPTP session helper for PPTP traffic (pptp)
l Remote shell session helper (rsh)
l Real-Time Streaming Protocol (RTSP) session helper (rtsp)
l Session Initiation Protocol (SIP) session helper (sip)
l Trivial File Transfer Protocol (TFTP) session helper (tftp)
l Oracle TNS listener session helper (tns)
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Viewing the session helper configuration
You can view the session helpers enabled on your FortiGate unit in the CLI using the commands below. The
following output shows the first two session helpers. The number of session helpers can vary to around 20.

show system session-helper
config system session-helper

edit 1
set name pptp
set port 1723
set protocol 6

next
set name h323
set port 1720
set protocol 6

end
.
.

The configuration for each session helper includes the name of the session helper and the port and protocol
number on which the session helper listens for sessions. Session helpers listed on protocol number 6 (TCP) or 17
(UDP). For a complete list of protocol numbers see Assigned Internet Protocol Numbers.

For example, the output above shows that FortiOS listens for PPTP packets on TCP port 1723 and H.323 packets
on port TCP port 1720.

If a session helper listens on more than one port or protocol the more than one entry for the session helper
appears in the config system session-helper list. For example, the pmap session helper appears twice
because it listens on TCP port 111 and UDP port 111. The rsh session helper appears twice because it listens on
TCP ports 514 and 512.

Changing the session helper configuration
Normally you will not need to change the configuration of the session helpers. However in some cases you may
need to change the protocol or port the session helper listens on.

Changing the protocol or port that a session helper listens on

Most session helpers are configured to listen for their sessions on the port and protocol that they typically use. If
your FortiGate unit receives sessions that should be handled by a session helper on a non-standard port or
protocol you can use the following procedure to change the port and protocol used by a session helper. The
following example shows how to change the port that the pmap session helper listens on for Sun RPC
portmapper TCP sessions. By default pmap listens on TCP port 111.

To change the port that the pmap session helper listens on to TCP port 112

1. Confirm that the TCP pmap session helper entry is 11 in the session-helper list:
show system session-helper 11

config system session-helper
edit 11

set name pmap
set port 111
set protocol 6

next
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end

2. Enter the following command to change the TCP port to 112.
config system session-helper

edit 11
set port 112

end

3. The pmap session helper also listens on UDP port 111. Confirm that the UDP pmap session helper entry is 12 in
the session-helper list:

show system session-helper 12
config system session-helper

edit 12
set name pmap
set port 111
set protocol 17

next
end

4. Enter the following command to change the UDP port to 112.
config system session-helper

edit 12
set port 112
end

Use the following command to set the h323 session helper to listen for ports on the UDP protocol.

To change the protocol that the h323 session helper listens on

1. Confirm that the h323 session helper entry is 2 in the session-helper list:
show system session-helper 2

config system session-helper
edit 2

set name h323
set port 1720
set protocol 6

next
end

2. Enter the following command to change the protocol to UDP.
config system session-helper

edit 2
set protocol 17
end

If a session helper listens on more than one port or protocol, then multiple entries for the session helper must be
added to the session helper list, one for each port and protocol combination. For example, the rtsp session helper
listens on TCP ports 554, 7070, and 8554 so there are three rtsp entries in the session-helper list. If your
FortiGate unit receives rtsp packets on a different TCP port (for example, 6677) you can use the following
command to configure the rtsp session helper to listen on TCP port 6677.

To configure a session helper to listen on a new port and protocol

config system session-helper
edit 0
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set name rtsp
set port 6677
set protocol 6
end

Disabling a session helper

In some cases you may need to disable a session helper. Disabling a session helper just means removing it from
the session-helper list so that the session helper is not listening on a port. You can completely disable a session
helper by deleting all of its entries from the session helper list. If there are multiple entries for a session helper on
the list you can delete one of the entries to prevent the session helper from listening on that port.

To disable the mgcp session helper from listening on UDP port 2427

1. Enter the following command to find the mgcp session helper entry that listens on UDP port 2427:
show system session-helper

.

.

.
edit 19

set name mgcp
set port 2427
set protocol 17

next
.
.
.

2. Enter the following command to delete session-helper list entry number 19 to disable the mgcp session helper
from listening on UDP port 2427:

config system session-helper
delete 19

By default the mgcp session helper listens on UDP ports 2427 and 2727. The previous procedure shows how to
disable the mgcp protocol from listening on port 2427. The following procedure completely disables the mgcp
session helper by also disabling it from listening on UDP port 2727.

To completely disable the mgcp session helper

1. Enter the following command to find the mgcp session helper entry that listens on UDP port 2727:
show system session-helper

.

.

.
edit 20

set name mgcp
set port 2727
set protocol 17

next
.
.
.

2. Enter the following command to delete session-helper list entry number 20 to disable the mgcp session helper
from listening on UDP port 2727:

config system session-helper
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delete 20

DCE-RPC session helper (dcerpc)
Distributed Computing Environment Remote Procedure Call (DCE-RPC) provides a way for a program running on
one host to call procedures in a program running on another host. DCE-RPC (also called MSRPC for Microsoft
RPC) is similar to ONC-RPC. Because of the large number of RPC services, for example, MAPI, the transport
address of an RPC service is dynamically negotiated based on the service program's universal unique identifier
(UUID). The Endpoint Mapper (EPM) binding protocol in FortiOSmaps the specific UUID to a transport address.

To accept DCE-RPC sessions you must add a security policy with service set to any or to the DEC-RPC pre-
defined service (which listens on TCP and UDP ports 135). The dcerpc session helper also listens on TCP and
UDP ports 135.

The session allows FortiOS to handle DCE-RPC dynamic transport address negotiation and to ensure UUID-
based security policy enforcement. You can define a security policy to permit all RPC requests or to permit by
specific UUID number.

In addition, because a TCP segment in a DCE-RPC stream might be fragmented, it might not include an intact
RPC PDU. This fragmentation occurs in the RPC layer; so FortiOS does not support parsing fragmented packets.

The DCE-RPC session helper does not support destination NAT (DNAT) or Firewall
VIPs unless you are using the OXID Resolver service (also called IOXIDResolver).

DNS session helpers (dns-tcp and dns-udp)
FortiOS includes two DNS session helpers, dns-tcp, a session helper for DNS over TCP, and dns-udp, a session
helper for DNS over UDP.

To accept DNS sessions you must add a security policy with service set to any or to the DNS pre-defined service
(which listens on TCP and UDP ports 53). The dns-udp session helper also listens on UDP port 53. By default the
dns-tcp session helper is disabled. If needed you can use the following command to enable the dns-tcp session
helper to listen for DNS sessions on TCP port 53:

config system session-helper
edit 0

set name dns-tcp
set port 53
set protocol 6

end

File transfer protocol (FTP) session helper (ftp)
The FTP session helper monitors PORT, PASV and 227 commands and NATs the IP addresses and port
numbers in the body of the FTP packets and opens ports on the FortiGate unit as required.

To accept FTP sessions you must add a security policy with service set to any or to the FTP, FTP_Put, and FTP_
GET pre-defined services (which all listen on TCP port 21).
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H.323 and RAS session helpers (h323 and ras)
The H.323 session helper supports secure H.323 voice over IP (VoIP) sessions between terminal endpoints such
as IP phones and multimedia devices. In H.323 VoIP networks, gatekeeper devices manage call registration,
admission, and call status for VoIP calls. The FortiOS h323 session helper supports gatekeepers installed on two
different networks or on the same network.

To accept H.323 sessions you must add a security policy with service set to any or to the H323 pre-defined service
(which listens on TCP port numbers 1720 and 1503 and on UDP port number 1719). The h323 session helper
listens on TCP port 1720.

The ras session helper is used with the h323 session helper for H.323 Registration, Admission, and Status (RAS)
services. The ras session helper listens on UDP port 1719.

Alternate H.323 gatekeepers

The h323 session helper supports using H.323 alternate gatekeepers. All the H.323 end points must register with
a gatekeeper through the Registration, Admission, and Status (RAS) protocol before they make calls. During the
registration process, the primary gatekeeper sends Gatekeeper Confirm (GCF) and Registration Confirm (RCF)
messages to the H.323 end points that contain the list of available alternate gatekeepers.

The alternate gatekeeper provides redundancy and scalability for the H.323 end points. If the primary gatekeeper
fails the H.323 end points that have registered with that gatekeeper are automatically registered with the
alternate gatekeeper. To use the H.323 alternate gatekeeper, you need to configure security policies that allow
H.323 end points to reach the alternate gatekeeper.

Media Gateway Controller Protocol (MGCP) session helper (mgcp)
The Media Gateway Control Protocol (MGCP) is a text-based application layer protocol used for VoIP call setup
and control. MGCP uses a master-slave call control architecture in which the media gateway controller uses a call
agent to maintain call control intelligence, while the media gateways perform the instructions of the call agent.

To accept MGCP sessions you must add a security policy with service set to any or to the MGCP predefined
service (which listens on UDP port numbers 2427 and 2727). The h323 session helper also listens on UDP port
numbers 2427 and 2727.

The MGCP session helper does the following:

l VoIP signaling payload inspection. The payload of the incoming VoIP signaling packet is inspected and malformed
packets are blocked.

l Signaling packet body inspection. The payload of the incoming MGCP signaling packet is inspected according to
RFC 3435. Malformed packets are blocked.

l Stateful processing of MGCP sessions. State machines are invoked to process the parsed information. Any out-of-
state or out-of-transaction packet is identified and properly handled.

l MGCPNetwork Address Translation (NAT). Embedded IP addresses and ports in packet bodies is properly
translated based on current routing information and network topology, and is replaced with the translated IP
address and port number, if necessary.

l Manages pinholes for VoIP traffic. To keep the VoIP network secure, the IP address and port information used for
media or signaling is identified by the session helper, and pinholes are dynamically created and closed during call
setup.
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ONC-RPC portmapper session helper (pmap)
Open Network Computing Remote Procedure Call (ONC-RPC) is a widely deployed remote procedure call
system. Also called Sun RPC, ONC-RPC allows a program running on one host to call a program running on
another. The transport address of an ONC-RPC service is dynamically negotiated based on the service's program
number and version number. Several binding protocols are defined for mapping the RPC program number and
version number to a transport address.

To accept ONC-RPC sessions you must add a security policy with service set to any or to the ONC-RPC pre-
defined service (which listens on TCP and UDP port number 111). The RPC portmapper session helper (called
pmap) handles the dynamic transport address negotiation mechanisms of ONC-RPC.

PPTP session helper for PPTP traffic (pptp)
The PPTP session help supports port address translation (PAT) for PPTP traffic. PPTP provides IP security at the
Network Layer. PPTP consists of a control session and a data tunnel. The control session runs over TCP and
helps in establishing and disconnecting the data tunnel. The data tunnel handles encapsulated Point-to-Point
Protocol (PPP) packets carried over IP.

To accept PPTP sessions that pass through the FortiGate unit you must add a security policy with service set to
any or to the PPTP pre-defined service (which listens on IP port 47 and TCP port 1723). The pptp session helper
listens on TCP port 1723.

PPTP uses TCP port 1723 for control sessions and Generic Routing Encapsulation (GRE) (IP protocol 47) for
tunneling the encapsulated PPP data. The GRE traffic carries no port number, making it difficult to distinguish
between two clients with the same public IP address. PPTP uses the source IP address and the Call ID field in the
GRE header to identify a tunnel. When multiple clients sharing the same IP address establish tunnels with the
same PPTP server, they may get the same Call ID. The call ID value can be translated in both the control
message and the data traffic, but only when the client is in a private network and the server is in a public network.

PPTP clients can either directly connect to the Internet or dial into a network access server to reach the Internet. A
FortiGate unit that protects PPTP clients can translate the clients’ private IP addresses to a pool of public IP
addresses using NAT port translation (NAT-PT). Because the GRE traffic carries no port number for address
translation, the pptp session helper treats the Call ID field as a port number as a way of distinguishing multiple
clients.

After the PPTP establishing a TCP connection with the PPTP server, the client sends a start control connection
request message to establish a control connection. The server replies with a start control connection reply
message. The client then sends a request to establish a call and sends an outgoing call request message.
FortiOS assigns a Call ID (bytes 12-13 of the control message) that is unique to each PPTP tunnel. The server
replies with an outgoing call reply message that carries its own Call ID in bytes 12-13 and the client’s call ID in
bytes 14-15. The pptp session helper parses the control connection messages for the Call ID to identify the call to
which a specific PPP packet belongs. The session helper also identifies an outgoing call request message using
the control message type field (bytes 8-9) with the value 7. When the session helper receives this message, it
parses the control message for the call ID field (bytes 12-13). FortiOS translates the call ID so that it is unique
across multiple calls from the same translated client IP. After receiving outgoing call response message, the
session helper holds this message and opens a port that accepts GRE traffic that the PPTP server sends. An
outgoing call request message contains the following parts:

l The protocol used for the outgoing call request message (usually GRE)
l Source IP address (PPTP server IP)
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l Destination IP address (translated client IP)
l Destination port number (translated client call ID)

The session helper identifies an outgoing call reply message using the control message type field (bytes 8-9) with
the value 8. The session helper parses these control messages for the call ID field (bytes 12-13) and the client’s
call ID (bytes 14-15). The session helper then uses the client’s call ID value to find the mapping created for the
other direction, and then opens a pinhole to accept the GRE traffic that the client sends.

An outgoing call reply message contains the following parts:

l Protocol used for the outgoing call reply message (usually GRE)
l Source IP address (PPTP client IP)
l Destination IP address (PPTP server IP)
l Destination port number (PPTP server Call ID)

Each port that the session opens creates a session for data traffic arriving in that direction. The session helper
opens the following two data sessions for each tunnel:

l Traffic from the PPTP client to the server, using the server’s call ID as the destination port
l Traffic from the PPTP server to the client, using the client’s translated call ID as the destination port

The default timeout value of the control connection is 30 minutes. The session helper closes the pinhole when
the data session exceeds the timeout value or is idle for an extended period.

Remote shell session helper (rsh)
Using the remote shell program (RSH), authenticated users can run shell commands on remote hosts. RSH
sessions most often use TCP port 514. To accept RSH sessions you must add a security policy with service set to
any or to the RSH pre-defined service (which listens on TCP port number 514).

FortiOS automatically invokes the rsh session helper to process all RSH sessions on TCP port 514. The rsh
session helper opens ports required for the RSH service to operate through a FortiGate unit running NAT or
transparent and supports port translation of RSH traffic.

Real-Time Streaming Protocol (RTSP) session helper (rtsp)
The Real-Time Streaming Protocol (RTSP) is an application layer protocol often used by SIP to control the
delivery of multiple synchronized multimedia streams, for example, related audio and video streams. Although
RTSP is capable of delivering the data streams itself it is usually used like a network remote control for
multimedia servers. The protocol is intended for selecting delivery channels (like UDP, multicast UDP, and TCP)
and for selecting a delivery mechanism based on the Real-Time Protocol (RTP). RTSPmay also use the SIP
Session Description Protocol (SDP) as a means of providing information to clients for aggregate control of a
presentation consisting of streams from one or more servers, and non-aggregate control of a presentation
consisting of multiple streams from a single server.

To accept RTSP sessions you must add a security policy with service set to any or to the RTSP pre-defined
service (which listens on TCP ports 554, 770, and 8554 and on UDP port 554). The rtsp session helper listens on
TCP ports 554, 770, and 8554.

The rtsp session help is required because RTSP uses dynamically assigned port numbers that are communicated
in the packet body when end points establish a control connection. The session helper keeps track of the port
numbers and opens pinholes as required. In Network Address Translation (NAT) mode, the session helper
translates IP addresses and port numbers as necessary.
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In a typical RTSP session the client starts the session (for example, when the user selects the Play button on a
media player application) and establishes a TCP connection to the RTSP server on port 554. The client then
sends an OPTIONSmessage to find out what audio and video features the server supports. The server responds
to the OPTIONSmessage by specifying the name and version of the server, and a session identifier, for example,
24256-1.

The client then sends the DESCRIBEmessage with the URL of the actual media file the client wants to play. The
server responds to the DESCRIBEmessage with a description of the media in the form of SDP code. The client
then sends the SETUPmessage, which specifies the transport mechanisms acceptable to the client for streamed
media, for example RTP/RTCP or RDT, and the ports on which it receives the media.

In a NAT configuration the rtsp session helper keeps track of these ports and addresses translates them as
necessary. The server responds to the SETUPmessage and selects one of the transport protocols. When both
client and server agree on a mechanism for media transport the client sends the PLAYmessage, and the server
begins streaming the media.

Session Initiation Protocol (SIP) session helper (sip)
The sip session helper is described in the VoIP Solutions: SIP Guide.

Trivial File Transfer Protocol (TFTP) session helper (tftp)
To accept TFTP sessions you must add a security policy with service set to any or to the TFTP pre-defined service
(which listens on UDP port number 69). The TFTP session helper also listens on UTP port number 69.

TFTP initiates transfers on UDP port 69, but the actual data transfer ports are selected by the server and client
during initialization of the connection. The tftp session helper reads the transfer ports selected by the TFTP client
and server during negotiation and opens these ports on the firewall so that the TFTP data transfer can be
completed. When the transfer is complete the tftp session helper closes the open ports.

Oracle TNS listener session helper (tns)
The Oracle Transparent Network Substrate (TNS) listener listens on port TCP port 1521 for network requests to
be passed to a database instance. The Oracle TNS listener session helper (tns) listens for TNS sessions on TCP
port 1521. TNS is a foundation technology built into the Oracle Net foundation layer and used by SQLNET.
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This section provides configuration concepts and techniques to enhance your network security and includes the
topics:

l Single firewall vs. multiple virtual domains
l Modem
l FortiExtender
l Assigning IP address by MAC address
l IP addresses for self-originated traffic
l Disk
l CLI Scripts
l Rejecting PING requests
l Opening TCP 113
l Obfuscate HTTP responses

You can also find a collection of practical articles on Fortinet's Cookbook site under Resources > SysAdmin
Notes.

Single firewall vs. multiple virtual domains
A typical FortiGate setup, with a small to mid-range appliance, enables you to include a number of subnets on
your network using the available ports and switch interfaces. This can potentially provide a means of having three
or more mini networks for the various groups in a company. Within this infrastructure, multiple network
administrators have access to the FortiGate to maintain security policies.

However, the FortiGate unit may not have enough interfaces to match the number of departments in the
organization. If the FortiGate unit it running in transparent mode however, there is only one interface, and
multiple network branches through the FortiGate are not possible.

A FortiGate unit with Virtual Domains (VDOMs) enabled, provides a means to provide the same functionality in
transparent mode as a FortiGate in NAT mode. VDOMs are a method of dividing a FortiGate unit into two or
more virtual units that function as multiple independent units. VDOMs can provide separate security policies and,
in NAT mode, completely separate configurations for routing and VPN services for each connected network. For
administration, an administrator can be assigned to each VDOM, minimizing the possibility of error or fouling
network communications.

By default, most FortiGate units support 10 VDOMs. Many FortiGate models support purchasing a license key to
increase the maximum number.

Single firewall vs. vdoms

When VDOMs are not enabled, and the FortiGate unit is in transparent mode, all the interfaces on your unit
become broadcast interfaces. The problem is there are no interfaces free for additional network segments.
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A FortiGate with three interfaces means only limited network segments are possible without purchasing more
FortiGate devices.

With multiple VDOMs you can have one of them configured in transparent mode, and the rest in NAT mode. In
this configuration, you have an available transparent mode FortiGate unit you can drop into your network for
troubleshooting, and you also have the standard.

This example shows how to enable VDOMs on the FortiGate unit and the basic and create a VDOM accounting
on the DMZ2 port and assign an administrator to maintain the VDOM. First enable Virtual Domains on the
FortiGate unit.

To enable VDOMs - web-based manager

1. Go to System > Dashboard > Status.
2. In the System Information widget, select Enable for Virtual Domain.
Note that on FortiGate-60 series and lower models, you need to enable VDOMs in the CLI only.

The FortiGate unit logs you out. Once you log back in, you will notice that the menu structure has changed. This
reflects the global settings for all Virtual Domains.

To enable VDOMs - CLI

config system global
set vdom-admin enable

end
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Next, add the VDOM called accounting.

To add a VDOM - web-based manager

1. Go toGlobal > VDOM > VDOM, and select Create New.
2. Enter the VDOM name accounting.
3. Select OK.

To add a VDOM - CLI

config vdom
edit <new_vdom_name>

end

With the Virtual Domain created, you can assign a physical interface to it, and assign it an IP address.

To assign physical interface to the accounting Virtual Domain - web-based manager

1. Go toGlobal > Network > Interface.
2. Select the DMZ2 port row and select Edit.
3. For the Virtual Domain drop-down list, select accounting.
4. Select the Addressing Mode of Manual.
5. Enter the IP address for the port of 10.13.101.100/24.
6. Set the Administrative Access to HTTPS and SSH.
7. Select OK.

To assign physical interface to the accounting Virtual Domain - CLI

config global
config system interface

edit dmz2
set vdom accounting
set ip 10.13.101.100/24
set allowaccess https ssh

next
end

Modem
FortiGate units support the use of wireless, 3G and 4G modems connected using the USB port or, if available,
the express card slot. Modem access provides either primary or secondary (redundant) access to the Internet. For
FortiGate units that do not include an internal modem (those units with an “M” designation), the modem interface
will not appear in the web-based manager until enabled in the CLI. To enable the modem interface enter the CLI
commands:

config system modem
set status enable

end

You will need to log out of the FortiGate and log back in to see the modem configuration page at Network >
Modem. Once enabled, modem options become available by going to Network > Interfaces.
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Note that the modem interface is only available when the FortiGate unit is in NAT mode.

To configure modem settings, go to > Network > Modem.

Configuring the modem settings is a matter of entering the ISP phone number, user name and password.
Depending on the modem, additional information may need to be supplied such as product identifiers, and
initialization strings.

The FortiGate unit includes a number of common modems within its internal database. You can view these by
selecting the Configure Modem link on theModem Settings page. If your modem is not on the list, select
Create New to add the information. This information is stored on the device, and will remain after a reboot.

Fortinet has an online database of modem models and configuration settings through FortiGuard. A subscription
to the FortiGuard services is not required to access the information. As models are added, you can select the
Configure Modem link and select Update Now to download new configurations.

USB modem port

Each USBmodem has a specific dial-out port. This will be indicated with the documentation for your modem. To
enable the correct USB port, use the CLI commands:

config system modem
set wireless-port {0 | 1 | 2}

end

To test the port, use the diagnose command:

diagnose sys modem com /1

The 1 will be the value of your USB port selected. The response will be:

Serial port: /dev/1
Press Ctrl+W to exit.

If the port does not respond the output will be:

Can not open modem device ‘/dev/1’ : Broken pipe

Modes

The FortiGate unit allows for two modes of operation for the modem; stand alone and redundant. In stand alone
mode, the modem connects to a dialup ISP account to provide the connection to the Internet. In redundant
mode, the modem acts as a backup method of connecting to the Internet, should the primary port for this function
fails.

Configuring either stand alone or redundant modes are very similar. The primary difference is the selection of the
interface that the modem will replace in the event of it failing, and the configuration of a PING server to monitor
the chosen interface.

Configuring stand alone mode

Configuring stand alone mode is a matter of configuring the modem information and the dialing mode. The dial
mode is eitherAlways Connect orDial on demand. Selecting Always Connect ensures that once the
modem has connected, it remains connected to the ISP. Selecting Dial on Demand, the modem only calls the
ISP if packets are routed to the modem interface. Once sent, the modem will disconnect after a specified amount
of time.

3163 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 28 - System Administration Advanced concepts

To configure standalone mode as needed - GUI

1. Go to Network > Modem.
2. Select theMode of Standalone.
3. Select the Dial Mode of Dial on Demand.
4. Select the number of redials the modem attempts if connection fails to 5.
5. Select Apply.

To configure standalone mode as needed- CLI

config system modem
set status enable
set mode standalone
set auto-dial enable
set redial 5

end

Configuring redundant mode

Redundant mode provides a backup to an interface, typically to the Internet. If that interface fails or disconnects,
the modem automatically dials the configured phone number(s). Once connected, the FortiGate unit routes all
traffic to the modem interface until the monitored interface is up again. The FortiGate unit pings the connection
to determine when it is back online.

For the FortiGate to verify when the interface is back up, you need to configure a Ping server for that interface.
You will also need to configure security policies between the modem interface and the other interfaces of the
FortiGate unit to ensure traffic flow.

To configure redundant mode as needed - GUI

1. Go to Network > Modem.
2. Select theMode of Redundant.
3. Select the interface the modem takes over from if it fails.
4. Select the Dial Mode of Dial on Demand.
5. Select the number of redials the modem attempts if connection fails to 5.
6. Select Apply.

To configure standalone mode as needed- CLI

config system modem
set status enable
set mode redundant
set interface wan1
set auto-dial enable
set redial 5

end

Link Health Monitor

Adding a link health monitor is required for routing fail over traffic. A link health monitor will confirm the
connectivity of the device’s interface
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To add a link health monitor

config system link-monitor
edit “Example1”

set srcint <Interface_sending_probe>
set server <ISP_IP_address>
set protocol <Ping or http>
set gateway-ip <the_gateway_IP_to_reach_the_server_if_required>
set failtime <failure_count>
set interval <seconds>
set update-cascade-interface enable
set update-static-route enable
set status enable

end

Additional modem configuration

The CLI provides additional configuration options when setting up the modem options including adding multiple
ISP dialing and initialization options and routing. For more information, see the CLI Reference.

Modem interface routing

The modem interface can be used in FortiOS as a dedicated interface. Once enabled and configured, you can
use it in security policies and define static and dynamic routing. Within the CLI commands for the modem, you
can configure the distance and priority of routes involving the modem interface. The CLI commands are:

config system modem
set distance <route_distance>
set priority <priority_value>

end

For more information on the routing configuration in the CLI, see the CLI Reference. For more information on
routing and configuring routing, see the Advanced Routing Guide.

Assigning IP address by MAC address
To prevent users in the from changing their IP addresses and causing IP address conflicts or unauthorized use of
IP addresses, you can bind an IP address to a specific MAC address using DHCP.

Use the CLI to reserve an IP address for a particular client identified by its device MAC address and type of
connection. The DHCP server then always assigns the reserved IP address to the client. The number of reserved
addresses that you can define ranges from 10 to 200 depending on the FortiGate model.

After setting up a DHCP server on an interface by going to Network > Interfaces, select the blue arrow next to
Advanced to expand the options. If you know the MAC address of the system select Create New to add it, or if
the system has already connected, locate it in the list, select the check box and select Add from DHCP Client
List.

You can also match an address to a MAC address in the CLI. In the example below, the IP address 10.10.10.55
for User1 is assigned to MAC address 00:09:0F:30:CA:4F.

config system dhcp reserved-address
edit User1

set ip 10.10.10.55
set mac 00:09:0F:30:CA:4F
set type regular

end
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IP addresses for self-originated traffic
On the FortiGate unit, there are a number of protocols and traffic that is specific to the internal workings of
FortiOS. For many of these traffic sources, you can identify a specific port/IP address for this self-originating
traffic. The following traffic can be configured to a specific port/IP address:

l SNMP
l Syslog
l alert email
l FortiManager connection IP
l FortiGuard services
l FortiAnalyzer logging
l NTP
l DNS
l Authorization requests such as RADIUS
l FSSO

Configuration of these services is performed in the CLI. In each instance, there is a command set source-ip.
For example, to set the source IP of NTP to be on the DMZ1 port with an IP of 192.168.4.5, the commands are:

config system ntp
set ntpsync enable
set syncinterval 5
set source-ip 192.168.4.5

end

To see which services are configured with source-ip settings, use the get command:

get system source-ip status

The output will appear similar to the sample below:

NTP: x.x.x.x
DNS: x.x.x.x
SNMP: x.x.x.x
Central Management: x.x.x.x
FortiGuard Updates (AV/IPS): x.x.x.x
FortiGuard Queries (WebFilter/SpamFilter): x.x.x.x

Disk
To view the status and storage information of the local disk on your FortiGate unit, go to System > Advanced.
The DiskSettingsmenu appears only on FortiGate units with an internal hard or flash disk.

Formatting the disk

The internal disk of the FortiGate unit (if available) can be formatted by going to System > Advanced and
selecting Disk Settings.

Formatting the disk will erase all data on it, including databases for antivirus and IPS; logs, quarantine files, and
WAN optimization caches. The FortiGate unit requires a reboot once the disk has been formatted.
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Setting space quotas

If the FortiGate unit has an internal hard or flash disk, you can allocate the space on the disk for specific logging
and archiving, and WAN optimization. By default, the space is used on an as required basis. As such, a disk can
fill up with basic disk logging, leaving less potential space for quarantine.

By going to System > Advanced, you can select the Edit icon for Logging and Archiving andWAN
Optimization & Web Cache and define the amount of space each log, archive and WAN optimization has on
the disk.

CLI Scripts
To upload bulk CLI commands and scripts, go to System > Advanced.

Scripts are text files containing CLI command sequences. Scripts can be used to deploy identical configurations
to many devices. For example, if all of your devices use identical security policies, you can enter the commands
required to create the security policies in a script, and then deploy the script to all the devices which should use
those same settings.

Use a text editor such as Notepad or other application that creates simple text files. Enter the commands in
sequence, with each line as one command, similar to examples throughout the FortiOS documentation set.

If you are using a FortiGate unit that is not remotely managed by a FortiManager unit or the FortiGuard Analysis
and Management Service, the scripts you upload are executed and discarded. If you want to execute a script
more than once, you must keep a copy on your management PC.

If your FortiGate unit is configured to use a FortiManager unit, you can upload your scripts to the FortiManager
unit, and run them from any FortiGate unit configured to use the FortiManager unit. If you upload a script directly
to a FortiGate unit, it is executed and discarded.

If your FortiGate unit is configured to use FortiGuard Analysis and Management Service, scripts you upload are
executed and stored. You can run uploaded scripts from any FortiGate unit configured with your FortiGuard
Analysis and Management Service account. The uploaded script files appear on the FortiGuard Analysis and
Management Service portal web site.

Uploading script files

After you have created a script file, you can then upload it through System > Advanced. When a script is
uploaded, it is automatically executed.

Commands that require the FortiGate unit to reboot when entered in the command line will also force a reboot if
included in a script.

To execute a script

1. Go to System > Advanced.
2. Enable Configuration Scripts.
3. Select Upload and Run a New Script to locate the script file.
4. Select Apply.
If the FortiGate unit is not configured for remote management, or if it is configured to use a FortiManager unit,
uploaded scripts are discarded after execution. Save script files to your management PC if you want to execute
them again later.
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If the FortiGate unit is configured to use the FortiGuard Analysis and Management Service, the script file is saved
to the remote server for later reuse. You can view the script or run it from the FortiGuard Analysis and
Management Service portal web site.

Auto repeat of CLI commands

Occasionally there is a need to repeatedly run a diagnose command over a long period of time (like checking CPU
or memory usage, or checking proxy health), Previously, this could only be done with external console
connections. With FortiOS 5.4.0, this can be done in a script using the interval and repeat commands.

Scripts can be uploaded as a file from the CLI or GUI. To upload scripts from the GUI go to System > Advanced
> Configuration Scripts and upload and run the script.

To configure the schedule and scripts, use the following syntax:

config system auto-script
edit <ScriptName>

set interval
set repeat
set script

end
end

interval the interval time in seconds between instances of the script running.

repeat the number of times to repeat the running of the script. The value 0 is used to set an infinite number of
repetitions.

start select manual to start the script manually or auto to start the script automatically

script the contents of the script.

This feature may not be available on all models as a hard drive is necessary to make use of it.

CLI option to limit script output size

The release of FortiOS 5.6 includes a new CLI command set output-size limits the size of an auto script in
megabytes and prevents the memory from being used up by the script's output.

CLI Syntax

config system auto-script
edit <script name>

set output-size <integer>
next

end

Enter an integer value from 10 to 1024. Default is 10.

Rejecting PING requests
The factory default configuration of your FortiGate unit allows the default external interface to respond to ping
requests. Depending on the model of your FortiGate unit the actual name of this interface will vary. For the most
secure operation, you should change the configuration of the external interface so that it does not respond to ping
requests. Not responding to ping requests makes it more difficult for a potential attacker to detect your FortiGate
unit from the Internet. One such potential threat are Denial of Service (DoS) attacks.

A FortiGate unit responds to ping requests if ping administrative access is enabled for that interface.
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To disable ping administrative access - web-based manager

1. Go to System > Network > Interface.
2. Choose the external interface and select Edit.
3. Clear the Ping Administrative Access check box.
4. Select OK.
In the CLI, when setting the allowaccess settings, by selecting the access types and not including the PING
option, that option is then not selected. In this example, only HTTPS is selected.

To disable ping administrative access - CLI

config system interface
edit external

set allowaccess https
end

Opening TCP 113
Although seemingly contrary to conventional wisdom of closing ports from hackers, this port, which is used for
ident requests, should be opened.

Port 113 initially was used as an authentication port, and later defined as an identification port (see RFC 1413).
Some servers may still use this port to help in identifying users or other servers and establish a connection.
Because port 113 receives a lot of unsolicited traffic, many routers, including on the FortiGate unit, close this
port.

The issue arises in that unsolicited requests are stopped by the FortiGate unit, which will send a response saying
that the port is closed. In doing so, it also lets the requesting server know there is a device at the given address,
and thus announcing its presence. By enabling traffic on port 113, requests will travel to this port, and will most
likely, be ignored and never responded to.

By default, the ident port is closed. To open it, use the following CLI commands:

config system interface
edit <port_name>

set ident_accept enable
end

You could also further use port forwarding to send the traffic to a non-existent IP address and thus never have a
response packet sent.

Obfuscate HTTP responses from SSL VPN
The FortiGate unit can obfuscate the HTTP responses from SSL VPN servers. By default this option is not
enabled. To obfuscate HTTP headers, use the following CLI command:

config vpn ssl settings
set url-obscuration {enable | disable}

end

Blocking land attacks in Transparent mode
Enabling blocking land attacks allows BFD echo packets to pass through the FortiGate.
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Since its a system settings option you can enable or disable blocking land attacks for individual VDOMs if your
FortiGate is operating with multiple VDOMs.

Another reason to enable this feature would be if your FortiGate is blocking BFD echo packets that should be
allowed to pass through the FortiGate. For example, a FortiGate operating in Transparent mode between two
routers with a policy that allows all traffic may block BFD echo communication between the routers if blocking
land attacks is disabled.

Use the following command to block land attacks and allow BFD echo packets. This option is disabled by default.

Syntax

config system settings
set block-land-attack enable

end
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Chapter 29 - Traffic Shaping

Traffic shaping

Welcome and thank you for selecting Fortinet products for your network protection.

With the ever-increasing demands on network systems for a number of protocols, including email, HTTP traffic
both internally and externally to the internet, voice over IP, FTP, and more, slow traffic is becoming a reality.
Important traffic may even be dropped or slowed to an unusable speed. Web traffic delays can result in a loss of
revenue for businesses.

Traffic shaping attempts to normalize traffic peaks and bursts to prioritize certain flows over others. There is a
physical limitation to the amount of data which can be buffered and to the length of time it can be buffered.

FortiGate units provide Quality of Service (QoS) by applying bandwidth limits and prioritization. Using traffic
shaping, you can adjust how your FortiGate unit allocates resources to different traffic types to improve
performance and stability of latency sensitive or bandwidth intensive network applications.

This chapter describes Quality of Service (QoS), traffic shaping, FortiGate traffic shaping algorithms, and
includes configuration procedures for traffic shaping on FortiGate units.

This guide contains the following sections:

The purpose of traffic shaping describes traffic shaping theories and quality of service.

Traffic shaping methods lists different methods of applying traffic shaping within FortiOS, and explains how to
use ToS and Differentiated Services.

Examples provides basic application scenarios for shapers.

Troubleshooting traffic shaping lists diagnose commands to use for determining if traffic shapers are working
correctly.
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What's new in FortiOS 5.6

This chapter describes new traffic shaping features added to FortiOS 5.6.3.

FortiOS 5.6.3
These features first appeared in FortiOS 5.6.3.

Support schedule on traffic shaping policy (450337)

In FortiOS 5.6, a new traffic "shaping-policy" feature was added, but it lacked the ability to apply different
shaping profiles at different times. This feature addresses this issue by adding a "schedule" attribute to the
shaping policy.

This feature is currently only available via the CLI, and you can use this feature to apply a reoccurring schedule to
your traffic shaping policies. The default recurring schedule options available are always or none. You can also
create new schedules or schedule groups under Policy & Objects > Schedules. This allows you to create
custom recurring or one-time schedules that can then be applied to your traffic shaping policies using the
commands below.

Syntax

config firewall shaping-policy
edit <shaping policy ID>

set schedule {always | none}
end
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The purpose of traffic shaping

Traffic shaping, or traffic management, controls the bandwidth available and sets the priority of traffic processed
by the policy to control the volume of traffic for a specific period (bandwidth throttling) or rate the traffic is sent
(rate limiting).

Traffic shaping attempts to normalize traffic peaks and bursts to prioritize certain flows over others. But there is a
physical limitation to the amount of data which can be buffered and to the length of time. Once these thresholds
have been surpassed, frames and packets will be dropped, and sessions will be affected in other ways.

A basic traffic shaping approach is to prioritize certain traffic flows over other traffic whose potential loss is less
disadvantageous. This would mean that you accept certain sacrifices in performance and stability on low-priority
traffic, to increase or guarantee performance and stability to high-priority traffic.

If, for example, you are applying bandwidth limitations to certain flows, you must accept the fact that these
sessions can be limited and therefore negatively impacted.

Note that traffic shaping is effective for normal IP traffic at normal traffic rates. Traffic shaping is not effective
during periods when traffic exceeds the capacity of the FortiGate unit. Because packets must be received by the
FortiGate unit before they are subject to traffic shaping, if the FortiGate unit cannot process all of the traffic it
receives, then dropped packets, delays, and latency are likely to occur.

To ensure that traffic shaping is working at its best, make sure that the interface Ethernet statistics show no
errors, collisions or buffer overruns.

Accelerated interfaces (NPx network processors and CE) affect traffic shaping. For more information, see the
FortiOS Hardware acceleration guide.

Quality of Service
Quality of Service (QoS) is the capability to adjust some quality aspects of your overall network traffic. This can
include such techniques as priority-based queuing and traffic policing. Because bandwidth is finite and because
some types of traffic are slow, jitter or packet loss sensitive, bandwidth intensive, or operation critical, QoS can be
a useful tool for optimizing the performance of the various applications on your network.

Before implementing QoS, organizations should first identify the types of traffic that are important to the
organization, the types of traffic that use high amounts of bandwidth, and the types of traffic that are sensitive to
latency or packet loss.

For example, a company might want to guarantee sufficient bandwidth for revenue producing e-commerce traffic.
They need to ensure that transactions can be completed and that clients do not experience service delays and
interruptions. At the same time, the company may need to ensure low latency for voice over IP (VoIP) traffic used
by sales and customer support, while traffic latency and bursts may be less critical to the success of other network
applications such as long term, resumable file transfers. Many organizations discover that QoS is especially
important for managing their voice and streaming multi-media traffic. These types of traffic can rapidly consume
bandwidth and are sensitive to latency.

Discovering the needs and relative importance of each traffic type on your network will help you to design an
appropriate overall approach, including how you will configure each available QoS component technique. Some
organizations discover that they only need to configure bandwidth limits for some services. Other organizations
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determine that they need to fully configure interface and security policy bandwidth limits for all services, and
prioritize queuing of critical services relative to traffic rate.

You can implement QoS on FortiGate units using the following techniques:

Traffic policing Drops packets that do not conform to bandwidth limitations.

Traffic shaping

Ensures that the traffic may consume bandwidth at least at the guaranteed
rate by assigning a greater priority queue if the guarantee is not being met.
Also ensures that the traffic cannot consume bandwidth greater than the
maximum at any given instance in time. Flows greater than the maximum
rate are subject to traffic policing.

Queuing Transmits packets in order of their assigned priority queue for that physical
interface. All traffic in a higher priority traffic queue must be completely
transmitted before traffic in lower priority queues will be transmitted.

When deciding how to configure QoS techniques, it can be helpful to know when FortiGate units employ each
technique in the overall traffic processing flow, and the considerations that arise from those mechanisms.

Traffic policing
The FortiGate unit begins to process traffic as it arrives (ingress) and departs (egress) on an interface. In later
phases of the network processing, such as enforcing maximum bandwidth use on sessions handled by a security
policy, if the current rate for the destination interface or traffic regulated by that security policy is too high, the
FortiGate unit may drop the packet. Time spent on prior processing, such as web filtering, decryption or IPS, is
often wasted on packets that are not forwarded. This applies to VLAN interfaces and physical interfaces.

You can prevent this wasted effort on ingress by configuring the FortiGate unit to preemptively drop excess
packets when they are received at the source interface, before most other traffic processing is performed:

config system interface
edit <interface_name>

set inbandwidth <rate_int>
next

end

where <rate_int> is the bandwidth limit in Kb/s. Excess packets will be dropped. If inbandwidth is 0, the
rate is not limited.

A similar command is available that can be performed on egress as well using the CLI commands:

config system interface
edit <interface_name>

set outbandwidth <rate_int>
next

end

As with ingress, setting the rate to 0 (zero) sets the rate to unlimited.

Rate limiting traffic accepted by the interface enables you to restrict incoming traffic to rates that, while no longer
the full capacity of the interface, at the traffic shaping point in the processing are more likely to result in
acceptable rates of outgoing traffic per destination interface or all security policies. This conserves FortiGate
processing resources for those packets that are more likely to be viable completely to the point of egress.
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Excessive traffic policing can degrade network performance rather than improve it. For more details on factors
that affect traffic policing, see Important considerations on page 3180.

NP6 interfaces on FortiGate devices don’t fully support bandwidth limits. When you set the outbandwidth setting
on an NP6 interface, the FortiGate implements a lower bandwidth limit than the one that you configure. The
inbandwidth setting has no effect on an NP6 interface, unless you disable NP offloading for the traffic on that
interface.

Bandwidth guarantee, limit, and priority interactions
After packet acceptance, the FortiGate unit classifies traffic and may apply traffic policing at additional points
during processing. It may also apply QoS techniques, such as prioritization and traffic shaping. Traffic shaping
consists of a mixture of traffic policing to enforce bandwidth limits, and priority queue adjustment to assist
packets in achieving the guaranteed rate.

If you have configured prioritization, the FortiGate unit prioritizes egressing packets by distributing them among
FIFO (first in, first out) queues associated with each possible priority number. Each physical interface has six
priority queues. Virtual interfaces do not have their own queues, and instead use the priority queues of the
physical interface to which they are bound.

Each physical interface’s six queues are queue 0 to queue 5, where queue 0 is the highest priority queue.
However, for the reasons described below, you may observe that your traffic uses only a subset of those six
queues. Some traffic may always use a certain queue number. Some queuing may vary by the packet rate or
mixture of services. Some queue numbers may be used only by through traffic for which you have configured
traffic shaping in the security policy that applies to that traffic session. For example:

l Administrative access traffic will always use queue 0.
l Traffic matching security policieswithout traffic shaping may use queue 0, queue 1, or queue 2. Which queue will

be used depends on the priority value you have configured for packets with that ToS (type of service) bit value, if
you have configured ToS-based priorities.

l Traffic matching security policieswith traffic shaping may use any queue. Which queue will be used depends on
whether the packet rate is currently below the guaranteed bandwidth (queue 0), or above the guaranteed
bandwidth. Packets at rates greater than the maximum bandwidth limit are dropped.

l If the global tos-based-priority is low (3), the priority in a traffic-shaper is medium (2) and a packet flows though a
policy that refers to the shaper, the packet will be assigned the priority defined by the shaper, in this case medium
(2).

Prioritization and traffic shaping behavior varies by your configuration, the service types and traffic volumes, and
by whether the traffic is through traffic, or the traffic originates from or terminates at the FortiGate unit itself.

FortiGate traffic
Security Policies do not apply to Administrative access to the FortiGate through HTTPS or SSH, or IPsec tunnel
negotiations, and therefore FortiGate units do not apply traffic shaping. Such traffic also uses the highest priority
queue, queue 0. In other words:

packet priority = 0

Exceptions to this rule include traffic types that are connections related to a session governed by a security policy.

For example, if you have enabled scanning by FortiGuard antivirus, traffic from the sender technically terminates
at the FortiGate proxy that scans that traffic type; the FortiGate unit initiates a second connection that transmits
scanned content to its destination. Because the second connection’s traffic is technically originating from the
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FortiGate proxy and therefore the FortiGate unit itself, it uses the highest priority queue, queue 0. However, this
connection is logically associated with through traffic, and is therefore subject to possible bandwidth enforcement
and guarantees in its governing security policy. In this way, it behaves partly like other through traffic.

Through traffic
For traffic passing through the FortiGate unit, the method a FortiGate unit uses to determine the priority queue
varies by whether Traffic Shaping is enabled or not. Packets may or may not use a priority queue directly or
indirectly derived from the type of service (ToS) bit — sometimes used instead with differentiated services— in
the packet’s IP header.

If Traffic Shaping is not applied to a security policy, the FortiGate unit neither limits nor guarantees bandwidth,
and traffic for that session uses the priority queue determined directly by matching the ToS bit in its header with
your configured values:

config system global
set traffic-priority tos
set traffic-priority-level {high | low | medium}
end

or, if you have configured a priority specifically for that ToS bit value:

config system tos-based-priority
edit <id_int>

set tos [0-15]
set priority {high | low | medium}

end

where tos is the value of the ToS bit in the packcet’s IP header, and high has a priority value of 0 and low is 2.
Priority values configured in the second location will override the global ToS-based priority. In other words:

packet priority = ToS-based priority

For example, you might specify that packets with a ToS bit value of 2 should use queue 0, the highest priority
queue:

config system tos-based-priority
edit 15

set tos 2
set priority high

next
end

If traffic shaping is applied to a security policy using a shared shaper, the FortiGate unit may subject packets to
traffic policing or priority queue increases in an effort to meet bandwidth guarantees configured in the shaper.

For example, you might create a Shared Shaper, where high has a priority value of 1 and low is 3, and <rate>
is the bandwidth limit in kilobits per second:

config firewall shaper traffic-shaper
edit <shaper_name>

...
set priority {high | medium | low}
set maximum-bandwidth <rate>
set guaranteed-bandwidth <rate>

end
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Note that it is also necessary to create a traffic shaping policy and set it to use the shared shaper:

config firewall shaping-policy
edit <policy ID>
...

set srcaddr <source address>
set dstaddr <destination address>
set service <service name>
set dstintf <destination interface list>
set traffic-shaper <shaper_name>

end

The diagram below illustrates traffic queuing as the packet rate increases.

Traffic queuing as the packet rate increases

l If the current packet rate is less than Guaranteed Bandwidth, packets use priority queue 0:

packet priority = 0

l If the current packet rate is greater than Guaranteed Bandwidth but less than Maximum Bandwidth, the FortiGate
unit assigns a priority queue by adding the numerical value of the security policy-based priority, where the value of
High is 1, and Low is 3, with the numerical value of the ToS-based priority, where high has a priority value of 0
and low is 2. Because the two values are added, depending on the configured ToS-based priorities, packets in this
category could use queues from queue 1 to queue 5. In other words:

packet priority = ToS-based priority + security policy-based priority

l If you have enabled Traffic Shaping in the security policy, and the security policy’s Traffic Priority is Low (value 3),
and the priority normally applied to packets with that ToS bit is medium (value 1), then packets have a total packet
priority of 4, and use priority queue 4.

l If the current packet rate exceeds Maximum Bandwidth, excess packets are dropped.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

3177



The purpose of traffic shaping Chapter 29 - Traffic Shaping

Calculation and regulation of packet rates

Packet rates specified for Maximum Bandwidth or Guaranteed Bandwidth are:

rate = amount / time

where rate is expressed in kilobits per second (Kb/s).

Burst size at any given instant cannot exceed the amount configured in Maximum Bandwidth. Packets in excess
are dropped. Packets deduct from the amount of bandwidth available to subsequent packets and available
bandwidth regenerates at a fixed rate. As a result, bandwidth available to a given packet may be less than the
configured rate, down to a minimum of 0 Kb/s.

Rate calculation and behavior can alternatively be described using the token bucket metaphor, where:

l A traffic flow has an associated bucket, which represents burst size bounds, and is the size of your configured
bandwidth limit.

l The bucket receives tokens, which represent available bandwidth, at the fixed configured rate.
l As time passes, tokens are added to the bucket, up to the capacity of the bucket; excess tokens are discarded.
l When a packet arrives, the packet must deduct bandwidth tokens from the bucket equal to its packet size in order to

egress.
l Packets cannot egress if there are insufficient tokens to pay for its egress; these nonconforming packets are

dropped.

Bursts are not redistributed over a longer interval, so bursts are propagated rather than smoothed, although their
peak size is limited.

Maximum burst size is the capacity of the bucket (the configured bandwidth limit); actual size varies by the
current number of tokens in the bucket, which may be less than bucket capacity, due to deductions from previous
packets and the fixed rate at which tokens accumulate. A depleted bucket refills at the rate of your configured
bandwidth limit. Bursts cannot borrow tokens from other time intervals. This behavior is illustrated in the graph
below.
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Bursts and bandwidth limits over time

By limiting traffic peaks and token regeneration in this way, the available bandwidth at any given moment may be
less than bucket capacity, but your limit on the total amount per time interval is ensured. Total bandwidth use
during each interval of 1 second is at most the integral of your configured rate.

You may observe that external clients, such as FTP or BitTorrent clients, initially report rates between Maximum
Bandwidth and twice that of Maximum Bandwidth, depending on the size of their initial burst. This is notably so
when a connection is initiated following a period of no network activity.The apparent discrepancy in rates is
caused by a difference in perspective when delimiting time intervals. A burst from the client may initially consume
all tokens in the bucket, and before the end of 1 second, as the bucket regenerates, be allowed to consume
almost another bucket’s worth of bandwidth. From the perspective of the client, this constitutes one time interval.
From the perspective of the FortiGate unit, however, the bucket cannot accumulate tokens while full; therefore,
the time interval for token regeneration begins after the initial burst, and does not contain the burst. These
different points of reference result in an initial discrepancy equal to the size of the burst — the client’s rate
contains it, but the FortiGate unit’s rate does not. If the connection is sustained to its limit and time progresses
over an increasing number of intervals, however, this discrepancy decreases in importance relative to the
bandwidth total, and the client’s reported rate will eventually approach that of the FortiGate unit’s configured rate
limit.

For example, your Maximum Bandwidth might be 50 Kb/s and there has been no network activity for one or more
seconds. The bucket is full. A burst from an FTP client immediately consumes 50 Kb. Because the bucket
completely regenerates over 1 second, by the time almost another 1 second has elapsed from the initial burst,
traffic can consume another 49.999 Kb, for a total of 99.999 Kb between the two points in time. From the vantage
point of an external FTP client regulated by this bandwidth limit, it therefore initially appears that the bandwidth
limit is 99.999 Kb/s, almost twice the configured limit of 50 Kb/s. However, bucket capacity only regenerates at
your configured rate of 50 Kb/s, and so the connection can only consume a maximum of 50 Kb during each
second thereafter. The result is that as bandwidth consumption is averaged over an increasing number of time
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intervals, each of which are limited to 50 Kb/s, the effects of the first interval’s doubled bandwidth size diminishes
proportionately, and the client’s reported rate eventually approaches your configured rate limit. The effects are
shown in the table below.

Effects of a 50 Kb/s limit on client reported rates

Total size transferred (Kb) Time (s) Rate reported by client (Kb/s)

99.999 (50 + 49.999) 1 99.999

149.999 2 74.999

199.999 3 66.666

249.999 4 62.499

299.999 5 59.998

349.999 6 58.333

... ... ...

Guaranteed Bandwidth can also be described using a token bucket metaphor. However, because this feature
attempts to achieve or exceed a rate rather than limit it, the FortiGate unit does not discard non-conforming
packets, as it does for Maximum Bandwidth; instead, when the flow does not achieve the rate, the FortiGate unit
increases the packets’ priority queue, in an effort to increase the rate.

Guaranteed and maximum bandwidth rates apply to the bidirectional total for all sessions controlled by the
security policy. For example, an FTP connection may entail two separate connections for the data and control
portion of the session; some packets may be reply traffic rather than initiating traffic. All packets for both
connections are counted when calculating the packet rate for comparison with the guaranteed and maximum
bandwidth rate.

Important considerations
By implementing QoS, you trade some performance and/or stability from traffic X by discarding packets or
introducing latency in order to improve performance and stability of traffic Y. The best traffic shaping
configuration for your network will balance the needs of each traffic flow by considering not only the needs of your
particular organization, but also the resiliency and other characteristics of each particular service.

For example, you may find that web browsing traffic is both more resistant to interruptions or latency and less
business critical than UDP or VoIP traffic, and so you might implement less restrictive QoSmeasures on UDP or
VoIP traffic than on HTTP traffic.

An appropriate QoS configuration will also take into account the physical limits of your network devices, and the
interactions of the aforementioned QoSmechanisms, described in Bandwidth guarantee, limit, and priority
interactions on page 3175.

You may choose to configure QoS differently based upon the hardware limits of your network and FortiGate unit.
Traffic shaping may be less beneficial in extremely high-volume situations where traffic exceeds a network
interface’s or your FortiGate model’s overall physical capacity. A FortiGate unit must have enough resources,
such as memory and processing power, to process all traffic it receives, and to process it at the required rate; if it
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does not have this capacity, then dropped packets and increased latency are likely to occur. For example, if the
total amount of memory available for queuing on a physical interface is frequently exceeded by your network’s
typical packet rates, frames and packets must be dropped. In such a situation, you might choose to implement
QoS using a higher model FortiGate unit, or to configure an incoming bandwidth limit on each interface.

Incorrect traffic shaping configurations can actually further degrade certain network flows, because excessive
discarding of packets or increased latency beyond points that can be gracefully handled by that protocol can
create additional overhead at upper layers of the network, which may be attempting to recover from these errors.
For example, a configuration might be too restrictive on the bandwidth accepted by an interface, and may
therefore drop too many packets, resulting in the inability to complete or maintain a SIP call.

To optimize traffic shaping performance, first ensure that the network interface’s Ethernet statistics are clean of
errors, collisions, or buffer overruns. To check the interface, enter the following diagnose command to see the
traffic statistics:

diagnose hardware deviceinfo nic <port_name>

If these are not clean, adjust FortiGate unit and settings of routers or other network devices that are connected to
the FortiGate unit. For more information, see Troubleshooting traffic shaping on page 3216.

Once Ethernet statistics are clean, you may want to use only some of the available FortiGate QoS techniques, or
configure them differently, based upon the nature of FortiGate QoSmechanisms described in Bandwidth
guarantee, limit, and priority interactions on page 3175.

Configuration considerations include:

l For maximum bandwidth limits, ensuring that bandwidth limits at the source interface and/or the security policy are
not too low, which can cause the FortiGate unit to discard an excessive number of packets.

l For prioritization, considering the ratios of how packets are distributed between available queues, and which queue
is used by which types of services. If you assign most packets to the same priority queue, it negates the effects of
configuring prioritization. If you assign many high bandwidth services to high priority queues, lower priority queues
may be starved for bandwidth and experience increased or indefinite latency. For example, you may want to
prioritize a latency-sensitive service such as SIP over a bandwidth-intensive service such as FTP. Consider also that
bandwidth guarantees can affect the queue distribution, assigning packets to queue 0 instead of their typical queue
in high-volume situations.

l You may or may not want to guarantee bandwidth, because it causes the FortiGate unit to assign packets to queue
0 if the guaranteed packet rate is not currently being met. Comparing queuing behavior for lower-bandwidth and
higher-bandwidth situations, this would mean that effects of prioritization only become visible as traffic volumes rise
and exceed their guarantees. Because of this, you might want only some services to use bandwidth guarantees, to
avoid the possibility that in high-volume situations all traffic uses the same queue, thereby negating the effects of
configuring prioritization.

l For prioritization, configure prioritization for all through traffic. You may want to configure prioritization by either
ToS-based priority or security policy priority, but not both. This simplifies analysis and troubleshooting.

Traffic subject to both security policy and ToS-based priorities will use a combined priority from both of those
parts of the configuration, while traffic subject to only one of the prioritization methods will use only that
priority. If you configure both methods, or if you configure either method for only a subset of your traffic,
packets for which a combined priority applies will frequently receive a lower priority queue than packets for
which you have only configured one priority method, or for which you have not configured prioritization.

For example, if both ToS-based priority and security policy priority both dictate that a packet should receive a
“medium” priority, in the absence of bandwidth guarantees, a packet will use queue 3, while if only ToS-based
priority had been configured, the packet would have used queue 1, and if only security policy-based priority had
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been configured, the packet would have used queue 2. If no prioritization had been configured at all, the
packet would have used queue 0.

For example alternative QoS implementations that illustrate these considerations, see Examples on page 3205.
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Traffic shaping methods

In FortiOS, there are three types of traffic shaping configurations. Each has a specific function, and all can be
used together in varying configurations. Policy shaping enables you to define the maximum bandwidth and the
guaranteed bandwidth set for a security policy. Per-IP shaping enables you to define traffic control on a more
granular level. Application traffic shaping goes further, enabling traffic controls on specific applications or
application groupings.

This chapter describes the types of traffic shapers and how to configure them in the web-based manager and the
CLI.

To configure traffic shaping in the web-based manager, you must enable the
Traffic Shaping feature under System > Feature Visibility.

Traffic shaping options
When configuring traffic shaping for your network, there are three different methods to control the flow of network
traffic to ensure that the desired traffic gets through while also limiting bandwidth for less important or bandwidth
consuming traffic. The three methods are the following:

l Shared policy shaping - bandwidth management by security policies
l Per-IP shaping - bandwidth management by user IP addresses
l Application control shaping - bandwidth management by application

Shapers allow you to define how traffic will flow by setting the traffic priority, bandwidth and DSCP options.
Shared policy shapers and Per-IP shapers are created under Policy & Objects > Traffic Shapers.

Traffic Shapers are then enabled within the traffic shaping policy, under Policy & Objects > Traffic Shaping Policy.

Application control shaping can be applied to any traffic shaping policy, under Policy & Objects > Traffic Shaping
Policy. You can control traffic by application category, application, and/or URL category.

To apply application control shaping, you must first enable application control at the
policy level, under Policy & Objects > IPv4 Policy.

Traffic shaping policies allow you to apply traffic shaping measures to any traffic matching your criteria. The
criteria must specify a source, a destination, a service, and the outgoing interface. Also, at least one type of
shaper must be enabled to create a traffic shaping policy.

The three different traffic shaping options offered by the FortiGate unit can be enabled at the same time within a
single traffic shaping policy. Generally, the hierarchy for traffic shapers in FortiOS is:

l Application control shaper
l Shared policy shaper
l Per-IP shaper
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Within this hierarchy, if an application control list has a traffic shaper defined, it will always have precedence over
any other policy shaper. For example, the Facebook application control example shown in Application control
shaping on page 3192 will supersede any security policy enabled traffic shapers. While the Facebook application
may reach its maximum bandwidth, the user can still have the bandwidth room available from the Shared Shaper
and, if enabled, the Per-IP shaper.

Equally, any security policy shared shaper will have precedence over any per-IP shaper. However, traffic that
exceeds any of these shapers will be dropped. For example, the policy shaper will take effect first, however, if the
per-IP shaper limit is reached first, then traffic for that user will be dropped even if the shared shaper limit for the
policy has not been exceeded.

Shared policy shaping
Traffic shaping by security policy enables you to control the maximum and/or guaranteed throughput for any
security policies specified in the Traffic Shaping Policy.

When configuring a shaper, you can select to apply the bandwidth shaping per policy or for all policies. Depending
on your selection, the FortiGate unit will apply the shaping rules differently.

By default shared shapers apply shaping evenly to all policies using it. For
Per policy and All policies using this shaper options to appear in the
web-based interface, you must first enable it in the CLI. Go to Policy
& Objects > Traffic Shapers and right-click on the shaper to edit it in the CLI.
Enter:

set per-policy enable
end

Per policy

When selecting a shared shaper to be per policy, the FortiGate unit will apply the shaping rules defined to each
security policy individually.

For example, if a shaper is set to per policy with a maximum bandwidth of 1000 Kb/s and applied to four security
policies, each policy has the same maximum bandwidth of 1000 Kb/s.

Per policy traffic shaping is compatible with client/server (active-passive) transparent mode WAN optimization
rules. Traffic shaping is ignored for peer-to-peer WAN optimization and for client/server WAN optimization not
operating in transparent mode.

For all policies using a shaper

When selecting a shared shaper to be for all policies -All Policies using this shaper - the FortiGate unit
applies the shaping rules to all policies using the same shaper. For example, the shaper is set to be per policy
with a maximum bandwidth of 1000 Kb/s. There are four security policies monitoring traffic through the FortiGate
unit. All four have the shaper enabled. Each security policy must share the defined 1000 Kb/s, and is set on a first
come, first served basis. For example, if policy 1 uses 800 Kb/s, the remaining three must share 200 Kb/s. As
policy 1 uses less bandwidth, it is opened up to the other policies to use as required. Once used, any other
policies will encounter latency until free bandwidth opens from a policy currently in use.
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Maximum and guaranteed bandwidth

The maximum bandwidth instructs the security policy what the largest amount of traffic allowed using the policy.
Depending on the service or the users included for the security policy, this number can provide a larger or smaller
throughput depending on the priority you set for the shaper.

TheMaximum Bandwidth can be set to a value of between 1 and 16776000 kbit/s. The Web-Based Manager
gives an error if any value outside of this range is used, but in the CLI a value of 0 can be entered. Setting the
maximum bandwidth to 0 provides unlimited bandwidth.

The guaranteed bandwidth ensures there is a consistent reserved bandwidth available for a given service or user.
When setting the guaranteed bandwidth, ensure that the value is significantly less than the bandwidth capacity of
the interface, otherwise no other traffic will pass through the interface or very little an potentially causing
unwanted latency.

Traffic priority

Select a Traffic Priority of high, medium or low, so the FortiGate unit manages the relative priorities of different
types of traffic. For example, a policy for connecting to a secure web server that needed to support e-commerce
traffic should be assigned a high traffic priority. Less important services should be assigned a low priority. The
firewall provides bandwidth to low-priority connections only when bandwidth is not needed for high-priority
connections.

Be sure to enable traffic shaping on all security policies. If you do not apply any traffic shaping rule to a policy, the
policy is set to high priority by default. Distribute security policies over all three priority queues.

Traffic shaping policy order

The traffic shaping policies must also be placed in the correct order in the traffic shaping policy list page to get the
desired results. It is necessary to arrange your traffic shaping policies into a sequence that places your more
granular policies above general internet access policies. For example, you would place any policies with
application control shaping at the top of the traffic shaping policy list. More general traffic shaping policies with
shared policy shapers and/or Per-IP shapers would follow.

The policy list page is located under Policy & Objects > Traffic Shaping Policy. You can change the order of your
policies by selecting the far left column to move the policy up or down. Make sure that the Seq.# column is shown
on your menu to easily verify a policy's position in the sequence.

The following example illustrates how to order your policies. The high priority VoIP traffic shaping policy is placed
at the top of the list, followed by restrictive policies to control streaming media, and your general internet access
policy is placed last.
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Traffic Shaping Policy Configuration Settings

To configure a traffic shaping policy go to Policy & Objects > Traffic Shaping Policy and select the Create New
“Plus” sign to create a new traffic shaping policy.

Set the "Matching Criteria" to the default options shown below or specify the criteria so that it matches a
specific security policy.

Source *all (default)

Destination *all (default)

Service *ALL (default)

Application Category -Choose an application category to apply shaping to a specific category of
applications. For example, P2P, Social.Media,or VoIP.

Application -Choose an application to specify which applications you wish to apply
traffic shaping to. For example, YouTube, Vimeo, or Facebook.

URL Category -Choose a URL category to block a subset of applications. For example,
potentially liable websites, security risks, or bandwidth consuming services.

Set Apply shaper to the following:

Outgoing Interface *any (Set this to the external interface you wish to apply shaping to. For
example, wan1 is often used.)

Shared Shaper

Choose one of the default shared shapers: guarantee-100kbps, high-
priority, medium-priority, low-priority, shared-1M-pipe or create your own
under Policy & Objects > Traffic Shapers. Shared Shapers share the alloted
bandwidth with any security policies using them (unless they are set to per-
policy in the CLI). This affects uploads or outbound traffic.

Reverse Shaper Choose one of the default shared shapers: guarantee-100kbps, high-
priority, medium-priority, low-priority, shared-1M-pipe, or create your own
under Policy & Objects > Traffic Shapers. This affects downloads or
inbound traffic.

Per-IP Shaper
Enable a Per-IP Shaper if you want to apply shaping by bandwidth
management by user IP addresses. Shapers are created under Policy
& Objects > Traffic Shapers. Per-IP shapers affect downloads and uploads.

Enable this policy Policies are enabled by default, but if you wish to disable a traffic shaping
policy de-select it here.

To create the traffic shaping policy - CLI:

config firewall shaping-policy
edit <shaping policy ID>

set srcaddr <source address>
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set dstaddr <destination address>
set service <service name>
set schedule {always | none}
application <application name>
app-category <application category ID list>
url-category <URL category ID list>
dstintf <destination interface list>
traffic-shaper <shared shaper name>
traffic-shaper-reverse <reverse traffic shaper name>
per-ip-shaper <per IP shaper name>

end

VLAN, VDOM and virtual interfaces

Policy-based traffic shaping does not use queues directly. It shapes the traffic and if the packet is allowed by the
security policy, then a priority is assigned. That priority controls what queue the packet will be put in upon egress.
VLANs, VDOMs, aggregate ports and other virtual devices do not have queues and as such, traffic is sent directly
to the underlying physical device where it is queued and affected by the physical ports. This is also the case with
IPsec connections.

Shared traffic shaper configuration settings

To configure a shared traffic shaper go to Policy & Objects > Traffic Shapers and select the Create New
“Plus” sign to create a new traffic shaper.

Type Select Shared.

Name Enter a name for the traffic shaper.

Apply Shaper When selecting a shaper to be Per Policy, the FortiGate unit will apply the
shaping rules defined to each security policy individually. For example, if a
shaper is set to per policy, with a maximum bandwidth of 1000 Kb/s, any
security policies that have that shaper enabled will get 1000 Kb/s of
bandwidth each.

When selecting a shaper to be for all policies - For All Policies Using
This Shaper - the FortiGate unit applies the shaping rules to all policies
using the same shaper. For example, the shaper is set to be per policy with
a maximum bandwidth of 1000 Kb/s. There are four security policies
monitoring traffic through the FortiGate unit. All four have the shaper
enabled. Each security policy must share the defined 1000 Kb/s, and is set
on a first come, first served basis. For example, if policy 1 uses 800 Kb/s,
the remaining three must share 200 Kb/s. As policy 1 uses less bandwidth,
that open bandwidth becomes available to the other policies to use as
required. Once used, any other policies will encounter latency until free
bandwidth opens from a policy currently in use.
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Traffic Priority

Select level of importance Priority so the FortiGate unit manages the
relative priorities of different types of traffic. For example, a policy for
connecting to a secure web server needed to support e-commerce traffic
should be assigned a high traffic priority. Less important services should be
assigned a low priority.

If you do not apply any traffic shaping priority, the priority is set to high
priority by default.

Maximum Bandwidth The maximum bandwidth instructs the security policy what the largest
amount of traffic allowed using the policy. Depending on the service or the
users included for the security policy, this number can provide a larger or
smaller throughput depending on the priority you set for the shaper.

SettingMaximum Bandwidth to 0 (zero) provides unlimited bandwidth.

Guaranteed Bandwidth

The guaranteed bandwidth ensures that a consistent reserved bandwidth
is available for a given service or user. Ensure that you set the bandwidth
to a value that is significantly less than the bandwidth capacity of the
interface. Otherwise little to no traffic will pass through the interface and
potentially cause unwanted latency.

SettingGuaranteed Bandwidth to 0 (zero) provides unlimited
bandwidth.

DSCP Enter the number for the DSCP value. You can use the FortiGate
Differentiated Services feature to change the DSCP (Differentiated
Services Code Point) value for all packets accepted by a policy. The
network can use these DSCP values to classify, mark, shape, and police
traffic, and to perform intelligent queuing. DSCP features are applied to
traffic by configuring the routers on your network to apply different service
levels to packets depending on the DSCP value of the packet. For more
information, see Traffic shaping methods.

Shared Shaper Per Policy Example

The following steps creates a Per Policy traffic shaper called “Throughput” with a maximum traffic amount of
720,000 Kb/s, and a guaranteed traffic of 150,000 Kb/s with a high traffic priority.

To create the shared shaper - web-based manager:

1. Go to Policy & Objects > Traffic Shapers and select the Create New “Plus” sign.
2. Set the Type to Shared.
3. Enter the Name Throughput.
4. Set the Apply shaper field to Per Policy.
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By default shared shapers apply shaping evenly to all policies using it. For
Per policy and All policies using this shaper options to appear in the
web-based interface, you must first enable it in the CLI. Go to Policy
& Objects > Traffic Shapers and right-click on the shaper to edit it in the CLI.
Enter:

set per-policy enable
end

5. Set the Traffic Priority to High.
6. Select theMaximum Bandwidth check box and enter the value 150000.
7. Select theGuaranteed Bandwidth check box and enter the value 120000.
8. Select OK.

To create the shared shaper - CLI:

config firewall shaper traffic-shaper
edit Throughput

set per-policy enable
set maximum-bandwidth 150000
set guaranteed-bandwidth 120000
set priority high

end

Per-IP shaping
Traffic shaping by IP enables you to apply traffic shaping to all source IP addresses in the security policy. As well
as controlling the maximum bandwidth users of a selected policy, you can also define the maximum number of
concurrent sessions.

Per-IP traffic shaping enables you limit the behavior of every member of a policy to avoid one user from using all
the available bandwidth - it now is shared within a group equally. Using a per-IP shaper avoids having to create
multiple policies for every user you want to apply a shaper. Per-IP traffic shaping is not supported over NP2
interfaces.

Per-IP traffic shaping configuration settings

To configure per-IP traffic shaping go to Policy & Objects > Traffic Shapers > Per-IP and select the Create
New “Plus” sign.

Type Select Per-IP.

Name Enter a name for the per-IP traffic shaper.

Maximum Bandwidth The maximum bandwidth instructs the security policy what the largest
amount of traffic allowed using the policy. Depending on the service or the
users included for the security policy, this number can provide a larger or
smaller throughput depending on the priority you set for the shaper.

SettingMaximum Bandwidth to 0 (zero) provides unlimited bandwidth.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

3189



Traffic shaping methods Chapter 29 - Traffic Shaping

Maximum Concurrent
Connections Enter the maximum allowed concurrent connection.

Forward DSCP
Reverse DSCP

Enter the number for the DSCP value. You can use the FortiGate
Differentiated Services feature to change the DSCP (Differentiated
Services Code Point) value for all packets accepted by a policy. The
network can use these DSCP values to classify, mark, shape, and police
traffic, and to perform intelligent queuing. DSCP features are applied to
traffic by configuring the routers on your network to apply different service
levels to packets depending on the DSCP value of the packet. For more
information, see Traffic shaping methods.

Example

The following steps create a Per-IP traffic shaper called “Accounting” with a maximum traffic amount of 720,000
Kb/s, and the number of concurrent sessions of 200.

To create the shared shaper - web-based manager:

1. Go to Policy & Objects > Traffic Shapers and select the Create New “Plus” Icon.
2. Set the Type to Per-IP.
3. Enter the Name Accounting.
4. Enable theMaximum Bandwidth and enter the value 720000.
5. Enable theMaximum Concurrent Sessions and enter the value 200.
6. Select OK.

To create the shared shaper - CLI:

config firewall shaper per-ip-shaper
edit Accounting

set max100-bandwidth 720000
set max-concurrent-session 200

end

Adding a Per-IP traffic shaper to a traffic shaping policy

Per-IP traffic shaping is supported by IPv6 security policies. You can add any Per-IP traffic shaper to an IPv6
security policy in the CLI.

Example

The following steps show you how to add an existing Per-IP traffic shaper to an IPv6 security policy. Make sure
that you have already created a Per-IP traffic shaper under Policy & Objects > Traffic Shapers.

To add a Per-IP traffic shaper to an IPv6 security policy - web-based manager:

1. Go to Policy & Objects > IPv6 Policy and click the Create New “Plus” icon to create an internet access policy.
2. Set the following:
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Name Enter a descriptive name.

Incoming Interface Internal

Source address All

Outgoing interface wan1

Destination address all

Schedule Always

Service Any

Action Accept

3. Select OK.
4. Go to Policy & Objects > Traffic Shaping Policy and the Create New “Plus” icon to create a new traffic shaping

policy.
5. To apply your traffic shaping policy to the security policy you created earlier set theMatching Criteria to the

following:

Source all

Destination address all

Service ALL

Application Category -

Application -

URL Category -

6. UnderApply shaper, set the following:

Outgoing interface any

(The outgoing interface should match the outgoing interface of the security
policy you wish to apply shaping to.)

Shared Shaper -

Reverse Shaper -

Per-IP Shaper Enable Per-IP Shaper and select your shaper from the dropdown menu.

Enable this policy Enable this policy.

7. Select OK.
8. On the policy list page, move the Per-IP Shaper to the top of the list by clicking on the far left column to drag and

drop it.
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There are two methods to configure traffic shaping in the CLI. You can add a Per-IP shaper directly to an IPv6
security policy, or you can add a Per-IP shaper to a traffic shaping policy. The second method will allow you to
apply traffic shaping based on the interface and can therefore affect multiple security policies easily. The first
method requires that you enable traffic shaping individually in ALL policies using the same two interfaces.

To add a Per-IP traffic shaper to an IPv6 security policy- CLI:

config firewall policy6
edit <security policy ID number>

set per-ip-shaper <per IP shaper name>
end

To add a Per-IP traffic shaper to an IPv6 traffic shaping policy -CLI:

config firewall shaping-policy
edit 1 <security policy ID number>

set ip-version 6
set srcaddr <source address>
set dstaddr <destination address>
set service <service name>
set dstintf <outgoing interface>
set per-ip-shaper <per IP shaper name>

end

Application control shaping
Traffic shaping is also possible for specific applications, too. Application control shaping works in conjunction with
a Shared Shaper or Per-IP Shaper. You must create a shaper with the bandwidth settings you would like to
enforce or edit one of the predefined shapers in the Policy & Objects > Traffic Shapers menu.

Traffic shaping policies allow you to enable these shapers and configure application control options. In the traffic
shaping policy, you can set an Application Category, Application, and URL Category. You must also specify
which security policies to apply your shaper to by setting theMatching Criteria.You can create a traffic shaping
policy in the Policy & Objects > Traffic Shaping Policy section.

For application control shaping to work, application control must be enabled
in a security policy, through Policy & Objects > IPv4 Policy or Policy
& Objects > IPv6 Policy under Security Profiles.

Also, application control shaping will only affect applications that are set to
pass in the Security Profiles > Application Control menu.

For more information on application control, see the FortiOS Security profiles Guide.

Example

This example sets the traffic shaping definition for Facebook to a medium priority, a default traffic shaper.

To add traffic shaping for Facebook - web-based manager:

1. Go to Policy & Objects > IPv4 Policy to create a general Internet access security policy.
2. Select the Create New “Plus” icon in the upper right corner of the screen to create a new security policy (or edit an
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existing Internet access policy).
3. Set the following to enable application control within a security policy:

Name <Enter a descriptive name.>

Incoming Interface Internal

Source address All

Outgoing interface wan1

Destination address all

Schedule Always

Service Any

Action Accept

Application Control Under Security Profiles, enable Application Control and select the default
application control profile.

4. Select OK.
5. Go to Policy & Objects > Traffic Shaping Policy and the Create New “Plus” icon to create a new traffic shaping

policy.
6. To apply your traffic shaping policy to the security policy you created earlier set theMatching Criteria to the

following:

Source all

Destination address all

Service ALL

Application Category Social.Media

Application Facebook

URL Category Social Networking

7. UnderApply shaper, set the following:

Outgoing interface any

(The outgoing interface should match the outgoing interface of the security
policy you wish to apply shaping to.)

Shared Shaper Enable Shared Shaper and selectmedium-priority from the drop down
menu.

Reverse Shaper Enable Shared Shaper and selectmedium-priority from the drop down menu.

Enable this policy Enable this policy.
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8. Select OK.
9. On the policy list page, move the facebook traffic shaping policy to the top of the list by clicking on the far left

column to drag and drop it.

To create a traffic shaping policy for Facebook - CLI:

config firewall shaping-policy
edit 1 <shaping policy ID number>

set srcaddr all
set dstaddr all
set service ALL
set application 15832
set app-category 23 <Social.Media>
set url-category 37 <Social Networking>
set dstintf wan1 <outgoing interface>
set traffic-shaper medium-priority
set reverse-traffic-shaper medium-priority

end

Reverse direction traffic shaping
The shaper you select in the traffic shaping policy (shared shaper) will affect the traffic in the direction defined in
the policy. For example, if the source port is lan and the destination is wan1, the shaping affects the flow in this
direction only— affecting the upload speed of the outbound traffic. By selecting Shared Traffic Shaper
Reverse Direction, you can define the traffic shaper for the policy in the opposite direction to affect the
download speed of the inbound traffic. In this example, from wan 1 to lan.

To add a reverse shaper

1. Go to Policy & Objects > Traffic Shaping Policy.
2. ClickCreate New or select an existing policy and clickEdit.
3. Set theMatching Criteria to match the interfaces of any security policies you wish to affect.
4. Navigate to the Apply shaper section, enable the Shared Shaper, and select a shaper from the dropdown

menu.
5. Enable the Reverse Shaper and select a shaper from the dropdown menu.
6. Select OK.

Setting the reverse direction only

There may be instances where you only need traffic shaping for incoming connections, which is in the “reverse”
direction of typical traffic shapers.

To add a reverse shaper - web-based manager:

1. Go to Policy & Objects > Traffic Shaping Policy.
2. ClickCreate New or select an existing policy and clickEdit.
3. Set theMatching Criteria to match the interfaces of any security policies you wish to affect.
4. Navigate to the Apply shaper section, enable the Reverse Shaper and select a shaper from the dropdown

menu.
5. Select OK.
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To configure a reverse-only shaper in a traffic shaping policy - CLI:

config firewall shaping-policy
edit <policy_number>

set reverse-traffic-shaper medium-priority
end

To configure a reverse-only shaper within a security policy- CLI:

config firewall policy
edit <policy_number>

...
set traffic-shaper-reverse <shaper_name>

end

Enabling traffic shaping in the security policy
Historically, FortiOS traffic shapers have always been enabled within a security policy.This is no longer the
easiest way to apply shapers, since in FortiOS 5.4 traffic shaping is now configured in the traffic shaping policy
section, under Policy & Objects > Traffic Shaping Policy. However, you can still enable traffic shapers within a
security policy using CLI commands and it will then appear in the web-based manager afterwards. The shapers
always go into effect after any DoS detection policies, and before any routing or packet scanning occurs.

Traffic shaping is also supported for IPv6 policies.

This is not the recommended method, as it is easier to keep track of and order your
traffic shaping policies if you configure them within a traffic shaping policy.

To enable traffic shaping within a security policy- CLI:

config firewall policy
edit <policy number>

...
set traffic-shaper <shaper name>
set reverse-traffic-shaper <shaper name>
set per-ip-shaper <per IP shaper name>

end

Shared shapers affect outbound traffic heading to a destination. To affect inbound traffic , or downloads, enable
the Reverse Shaper, too. For more information, see Reverse direction traffic shaping on page 3194.

Scheduling Traffic Shaping Policies
In FortiOS 5.6.3, a new scheduling feature was added to traffic shaping policies to apply different shaping profiles
at different times (450337). This "schedule" attribute is currently only available via the CLI, and you can use
this feature to apply a reoccurring schedule to your traffic shaping policies. The default recurring schedule options
available are always or none. You can also create new schedules or schedule groups under Policy & Objects >
Schedules. This allows you to create custom recurring or one-time schedules that can then be applied to your
traffic shaping policies using the commands below.
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Syntax

config firewall shaping-policy
edit <shaping policy ID>

set schedule {always | none}
end

Type of Service priority
Type of service (ToS) is an 8-bit field in the IP header that enables you to determine how the IP datagram should
be delivered, using criteria of Delay, Throughput, Priority, Reliability, and Cost. Each quality helps gateways
determine the best way to route datagrams. A router maintains a ToS value for each route in its routing table. The
lowest priority ToS is 0; the highest is 7 when bits 3, 4, and 5 are all set to 1. There are other seldom used or
reserved bits that are not listed here.

Together these bits are the ToS variable of the tos-based-priority command. The router tries to match
the ToS of the datagram to the ToS on one of the possible routes to the destination. If there is no match, the
datagram is sent over a zero ToS route. Using increased quality may increase the cost of delivery because better
performance may consume limited network resources.

Each bit represents the priority as per RFC 1349:

l 1000 - minimize delay
l 0100 - maximize throughput
l 0010 - maximize reliability
l 0001 - minimize monetary cost

The ToS value is set in the CLI using the commands:

config system tos-based-priority
edit <sequence-number>

set tos [0-15]
set priority [high | medium | low]

end

Where tos is the value of the type of service bit in the IP datagram header with a value between 0 and 15, and
priority is the priority of this type of service priority. These priority levels conform to the firewall traffic shaping
priorities, as defined in RFC 1349.

For example, if you want to configure the FortiGate unit so that reliability is the first priority, set the tos value to 4.

config system tos-based-priority
edit 1

set tos 4
set priority high

end

For a list of ToS values and their DSCP equivalents see Traffic shaping methods on page 3183.

Example

config system tos-based-priority
edit 1

set tos 1
set priority low
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next
edit 4

set tos 4
set priority medium

next
edit 6

set tos 6
set priority high

next
end

ToS in FortiOS

Traffic shaping and ToS follow the following sequence:

l The CLI command tos-based-priority acts as a tos-to-priority mapping. FortiOSmaps the ToS to a
priority when it receives a packet.

l Traffic shaping settings adjust the packet’s priority according the traffic.
l Deliver the packet based on its priority.

Traffic Shaping Units of Measurement

Bandwidth speeds are measured in kilobits per second (Kbps), and bytes that are sent/received are measured in
megabytes (MB). Occasionally this can cause confusion depending on whether your ISP uses kilobits per second
(kbps), kilobytes (KB), megabits per second (mbps), or gigabits per second (gbps).

Download Speeds

l 1 kilobyte per second (KBps) = 8 kilobits per second (Kbps)
l 1 megabit per second (Mbps) = 1,000,000 bits per second (bps)
l 1 gigabit per second (Gbps) = 1,000 megabits per second (Mbps)

File Sizes

l 1 megabyte (MB) = 1,024 kilobytes (KB)
l 1 gigabyte (GB) = 1,024 megabytes (MB) or 1,048,576 kilobytes (KB)

To change a shaper's unit of measurement - CLI

config firewall shaper traffic-shaper
edit <shaper name>

set bandwidth-unit {kbps | mbps | gbps}
end

Differentiated Services
Differentiated Services describes a set of end-to-end Quality of Service (QoS) capabilities. End-to-end QoS is the
ability of a network to deliver service required by specific network traffic from one end of the network to another.
By configuring differentiated services, you configure your network to deliver particular levels of service for
different packets based on the QoS specified by each packet.

Differentiated Services (also called DiffServ) is defined by RFC 2474 and 2475 as enhancements to IP networking
to enable scalable service discrimination in the IP network without the need for per-flow state and signaling at
every hop. Routers that can understand differentiated services sort IP traffic into classes by inspecting the DS
field in IPv4 header or the Traffic Class field in the IPv6 header.
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You can use the FortiGate Differentiated Services feature to change the DSCP (Differentiated Services Code
Point) value for all packets accepted by a policy. The network can use these DSCP values to classify, mark,
shape, and police traffic, and to perform intelligent queuing. DSCP features are applied to traffic by configuring
the routers on your network to apply different service levels to packets depending on the DSCP value of the
packet.

If the differentiated services feature is not enabled, the FortiGate unit treats traffic as if the DSCP value is set to
the default (00), and will not change IP packets' DSCP field. DSCP values are also not applied to traffic if the
traffic originates from a FortiGate unit itself.

The FortiGate unit applies the DSCP value and IPsec encryption to the differentiated services (formerly ToS) field
in the first word of the IP header. The typical first word of an IP header, with the default DSCP value, is 4500:

l 4 for IPv4
l 5 for a length of five words
l 00 for the default DSCP value

You can change the packet's DSCP field for traffic initiating a session (forward) or for reply traffic (reverse) and
enable each direction separately and configure it in the security policy.

Changes to DSCP values in a security policy effect new sessions. If traffic must use the new DSCP values
immediately, clear all existing sessions.

DSCP is enabled using the CLI command:

config firewall policy
edit <policy_number>

...
set diffserv-forward enable
set diffservcode-forward <binary_integer>
set diffserv-reverse enable
set diffservcode-rev <binary_integer>

end

For more information on the different DCSP commands, see the examples below and the CLI Reference. If you
only set diffserv-forward and diffserv-reverse without setting the corresponding diffvercode
values, the FortiGate unit will reset the bits to zero.

For a list of DSCP values and their ToS equivalents see Differentiated Services on page 3197. DSCP values can
also be defined within a shared shaper as a single value, and per-IP shaper for forward and reverse directions.

DSCP examples
For all the following DSCP examples, the FortiGate and client PC configuration is the following diagram and used
firewall-based DSCP configurations.
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Example

In this example, an ICMP ping is executed between User 1 and FortiGate B, through a FortiGate unit. DSCP is
disabled on FortiGate B, and FortiGate A contains the following configuration:

config firewall policy
edit 2

set srcintf port6
set dstintf port3
set src addr all
set dstaddr all
set action accept
set schedule always
set service ALL
set diffserv-forward enable
set diffservcode-forward 101110

end

As a result, FortiGate A changes the DSCP field for outgoing traffic, but not to its reply traffic. The binary DSCP
values used map to the following hexadecimal

ToS field values, which are observable by a sniffer (also known as a packet tracer):

l DSCP 000000 is TOS field 0x00
l DSCP 101110 is TOS field 0xb8, the recommended DSCP value for expedited forwarding (EF)

If you performed an ICMP ping between User 1 and User 2, the following output illustrates the IP headers for the
request and the reply by sniffers on each of FortiGate unit’s network interfaces. The right-most two digits of each
IP header are the ToS field, which contains the DSCP value.

4500 4500 45b8 45b8 45b8 45b8

45004500450045004500

User 1 User 2

4500
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Example

In this example, an ICMP ping is executed between User 1 and FortiGate B, through FortiGate A. DSCP is
disabled on FortiGate B, and FortiGate A contains the following configuration:

config firewall policy
edit 2

set srcintf port6
set dstintf port3
set src addr all
set dstaddr all
set action accept
set schedule always
set service ALL"
set diffserv-forward enable
set diffserv-rev enable
set diffservcode-forward 101110
set diffservcode-rev 101111

end

As a result, FortiGate A changes the DSCP field for both outgoing traffic and its reply traffic. The binary DSCP
values in map to the following hexadecimal ToS field values, which are observable by a sniffer (also known as a
packet tracer):

l DSCP 000000 is TOS field 0x00
l DSCP 101110 is TOS field 0xb8, the recommended DSCP value for expedited forwarding (EF)
l DSCP 101111 is TOS field 0xbc

If you performed an ICMP ping between User 1 and User 2, the output below illustrates the IP headers observed
for the request and the reply by sniffers on each of FortiGate A's and FortiGate B's network interfaces. The right-
most two digits of each IP header are the ToS field, which contains the DSCP value.

4500 4500 45b8 45b8 45b8 45b8

450045004500450045bc

User 1 User 2

45bc

Example

In this example, an ICMP ping is executed between User 1 and FortiGate B, through FortiGate A. DSCP is
enabled for both traffic directions on FortiGate A, and enabled only for reply traffic on FortiGate B. FortiGate A
contains the following configuration:

config firewall policy
edit 2

set srcintf port6
set dstintf port3
set src addr all
set dstaddr all
set action accept
set schedule always
set service ALL
set diffserv-forward enable
set diffserv-rev enable
set diffservcode-forward 101110
set diffservcode-rev 101111

end
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FortiGate B contains the following configuration:

config firewall policy
edit 2

set srcintf wan2
set dstintf internal
set src addr all
set dstaddr all
set action accept
set schedule always
set service ALL
set diffserv-rev enable
set diffservcode-rev 101101

end

As a result, FortiGate A changes the DSCP field for both outgoing traffic and its reply traffic, and FortiGate B
changes the DSCP field only for reply traffic. The binary DSCP values in this configuration map to the following
hexadecimal ToS field values:

l DSCP 000000 is TOS field 0x00
l DSCP 101101 is TOS field 0xb4
l DSCP 101110 is TOS field 0xb8, the recommended DSCP value for expedited forwarding (EF)
l DSCP 101111 is TOS field 0xbc

If you performed an ICMP ping between User 1 and User 2, the output below illustrates the IP headers observed
for the request and the reply by sniffers on each of FortiGate A's and FortiGate B's network interfaces. The right-
most two digits of each IP header are the ToS field, which contains the DSCP value.

4500 4500 45b8 45b8 45b8 45b8

4500450045b445b445bc

User 1 User 2

45bc

Example

In this example, HTTPS and DNS traffic is sent from User 1 to FortiGate B, through FortiGate A. DSCP is
enabled for both traffic directions on FortiGate A, and enabled only for reply traffic on FortiGate B. FortiGate A
contains the following configuration:

config firewall policy
edit 2

set srcintf port6
set dstintf port3
set src addr all
set dstaddr all
set action accept
set schedule always
set service ALL
set diffserv-forward enable
set diffserv-rev enable
set diffservcode-forward 101110
set diffservcode-rev 101111

end

FortiGate B contains the following configuration:

config firewall policy
edit 2
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set srcintf wan2
set dstintf internal
set src addr all
set dstaddr all
set action accept
set schedule always
set service ALL
set diffserv-rev enable
set diffservcode-rev 101101

end

As a result, FortiGate A changes the DSCP field for both outgoing traffic and its reply traffic, but FortiGate B
changes the DSCP field only for reply traffic which passes through its internal interface. Since the example traffic
does not pass through the internal interface, FortiGate B does not mark the packets. The binary DSCP values in
this configuration map to the following hexadecimal ToS field values:

l DSCP 000000 is TOS field 0x00
l DSCP 101101 is TOS field 0xb4, which is configured on FortiGate B but not observed by the sniffer because the

example traffic originates from the FortiGate unit itself, and therefore does not match that security policy.
l DSCP 101110 is TOS field 0xb8, the recommended DSCP value for expedited forwarding (EF)
l DSCP 101111 is TOS field 0xbc

If you sent HTTPS or DNS traffic from User 1 to FortiGate B, the following would illustrate the IP headers
observed for the request and the reply by sniffers on each of FortiGate A's and FortiGate B's network interfaces.
The right-most two digits of each IP header are the ToS field, which contains the DSCP value.

4500 4500 45b8 45b8

4500450045bc

User 1 User 2

45bc

ToS and DSCP traffic mapping
There are two types of traffic mapping: Type of Service (ToS) or DSCP (Differentiated Services Code Point). Only
one method can be used at a time, with ToS set as the default method. You can set the type used and attributes
in the CLI.

To set ToS or DSCP traffic mapping

config system global
set traffic-priority {tos | dscp}
set traffic-priority-level {low | medium | high }

end

Mapping of DSCP and ToS hexadecimal values for QoS

Service Class DSCP Bits DSCP Value ToS Value ToS Hexidecimal

Network Control 111000 56-63 224 0xE0

Internetwork
Control 110000 48-55 192 0xC0
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Service Class DSCP Bits DSCP Value ToS Value ToS Hexidecimal

Critical - Voice
Data (RTP)

101110 46 184 0xB8

101000 40 160 0xA0

Flash Override
Video Data

100010 34 136 0x88

100100 36 144 0x90

100110 38 152 0x98

100000 32 128 0x80

Flash Voice
Control

011010 26 104 0x68

011100 28 112 0x70

011110 30 120 0x78

011000 24 96 0x60

Immediate
Deterministic
(SNA)

010010 18 72 0x48

010100 20 80 0x50

010110 22 88 0x58

010000 16 64 0x40

Priority
Controlled Load

001010 10 40 0x28

001100 12 48 0x30

001110 14 56 0x38

001000 8 32 0x20

Routine - Best
Effort

000000 0 0 0x00

Routine - Penalty
Box 000010 2 8 0x08

Traffic Shaper Monitor
You can view statistical information about traffic shapers and their bandwidth from FortiView > Traffic Shaping.
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Refresh the information on the page.

Table View shows the following columns by default: Shaper, Bytes
(Sent/Received), Sessions, Bandwidth, or Dropped Bytes. For more display
options, right-click on the column header.

Bubble Chart shows you which resources consume the most bandwidth.
Double-click on a shaper to view more details. Determine whether more
granular shaping is required by looking at the bandwidth usage by sources,
destinations, applications, policies, and sessions.

FortiView Settings include the following options:
l Include Local traffic (Realtime Only)
l Include Unscanned Applications (Applications View Only)
l Auto update realtime visualizations
l Interval (seconds)
l Threat Weight Settings
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Examples

While it is possible to configure QoS using a combination of security policies and ToS based priorities, and to
distribute traffic over all six of the possible queues for each physical interface, the results of those configurations
can be more difficult to analyze due to their complexity. In those cases, prioritization behavior can vary by several
factors, including traffic volume, ToS (type of service) or differentiated services markings, and correlation of
session to a security policy.

The following simple examples illustrate QoS configurations using either prioritization by security policy, or
prioritization by ToS bit, but not both. The examples also assume you are not configuring traffic shaping for
interfaces that receive hardware acceleration from network processing units (NPU).

QoS using priority from security policies
Configurations implementing QoS using the priority values defined in the security policies are capable of applying
bandwidth limits and guarantees.

In addition to configuring traffic shaping, you may also choose to limit the bandwidth accepted by each interface.
This can be useful in scenarios where the bandwidth received on source interfaces frequently exceeds the
maximum bandwidth limit defined in the security policy. Rather than waste processing power on packets that will
get dropped later in the process, you may choose to preemptively police the traffic.

If you decide to implement QoS using security policies rather than ToS bit, the FortiGate unit applies QoS to all
packets controlled by the policy. This type of control is less granular than prioritization by ToS bit, but has the
benefits of correlating quality of service to a security policy. This correlation enables you to distribute traffic over
up to four of the possible 6 priority queues (queue 0 to queue 3), does not require other devices in your network to
set or respect the ToS bit, and enables you to configure bandwidth limits and guarantees.

In the following example, we limit the bandwidth accepted by each source interface, limit the bandwidth used by
sessions controlled by the security policy, and then configure prioritized queuing on the destination interface
based upon the priority in the security policy, subject to alternative assignment to queue 0 when necessary to
achieve the guaranteed packet rate.

To limit bandwidth accepted by an interface

In the CLI, enter the following commands:

config system interface
edit <name_str>

set inbandwidth <rate_int>
next

end

where <rate_int> is the bandwidth limit in Kb/s. Excess packets will be dropped.

To configure bandwidth guarantees, limits, and priorities

1. Go to Policy & Objects > Traffic Shapers and select the Create New “Plus” sign.
2. Select Shared or Per-IP.
3. Enter a name for the shaper.
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4. Select the Traffic Priority.
High has a priority value of 1, Medium is 2, and Low is 3. While the current packet rate is below Guaranteed
Bandwidth, the FortiGate unit will disregard this setting, and instead use priority queue.

5. Enable Max Bandwidth and enter a value.
Packets greater than this rate will be discarded.

6. EnableGuaranteed Bandwidth and enter a value, if any.
Bandwidth guarantees affect prioritization. While packet rates are less than this rate, they use priority queue 0. If
this is not the effect you intend, consider entering a small guaranteed rate, or enter 0 to effectively disable
bandwidth guarantees.

7. Enable DSCP and set a value.
8. Select OK.

Per-IP shapers also include the option to set a maximum number of concurrent
connections and to set both Forward DSCP and Reverse DSCP.

Sample configuration

This sample configuration limits ingressing bandwidth to 500 Kb/s. It also applies separate traffic shapers to FTP
and HTTP traffic. In addition to the interface bandwidth limit, HTTP traffic is subject to a security policy
bandwidth limit of 200 Kb/s.

All egressing FTP traffic greater than 10 Kb/s is subject to a low priority queue (queue 3), while all egressing
HTTP traffic greater than 100 Kb/s is subject to a medium priority queue (queue 2). That is, unless FTP traffic
rates are lower than their guaranteed rate, and web traffic rates are greater than their guaranteed rate, FTP traffic
is lower priority than web traffic.

Traffic less than these guaranteed bandwidth rates use the highest priority queue (queue 0).

Set the inbandwidth limits. This setting is only available in the CLI:

config system interface
edit wan1

set inbandwidth 500
next

end

Create traffic shapers for FTP and HTTP.

To configure an FTP shaper - web-based manager:

1. Go to Policy & Objects > Traffic Shapers, and select the Create New “Plus” icon.
2. Select Shared.
3. Enter FTP for the name of the shaper.
4. Set Traffic Priority to Low.
5. Select theGuaranteed Bandwidth checkbox and enter 10 Kbps.
6. Select theMaximum Bandwidth checkbox and enter 500 Kbps.
7. Select OK.
8. Select the FTP shaper, right-click it, and select Edit in CLI. Type the following command: 

set per-policy
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end

To configure an HTTP shaper - web-based manager:

1. Select the Create New “Plus” icon.
2. Set Type to Shared.
3. Enter HTTP for the name of the shaper.
4. Set Traffic Priority to Medium.
5. Select theGuaranteed Bandwidth checkbox and enter 100 Kbps.
6. Select theMaximum Bandwidth checkbox and enter 200 Kbps.
7. Select OK.
8. Select the HTTP shaper, right-click it, and select Edit in CLI. Type the following command: 

set per-policy
end

To add the FTP shaper to a traffic shaping policy - web-based manager:

1. Go to Policy & Objects > Traffic Shaping Policy and clickCreate New to create a traffic shaping policy for
FTP.

2. Set theMatching Criteria to the following:

Source all

Destination address all

Service FTP

3. UnderApply shaper, set the following:

Outgoing interface any (The outgoing interface should match the outgoing interface of the security
policy you wish to apply shaping to.)

Shared Shaper Enable Shared Shaper and select FTP from the dropdown menu.

Reverse Shaper Enable Shared Shaper and select FTP from the dropdown menu.

Enable this policy Enable this policy.

4. Select OK.

To add the HTTP shaper to a traffic shaping policy - web-based manager:

1. Go to Policy & Objects > Traffic Shaping Policyand clickCreate New to create a traffic shaping policy for
HTTP.

2. Set theMatching Criteria to the following:

Source all
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Destination address all

Service HTTP

3. UnderApply shaper, set the following:

Outgoing interface any (The outgoing interface should match the outgoing interface of the security
policy you wish to apply shaping to.)

Shared Shaper Enable Shared Shaper and select HTTP from the dropdown menu.

Reverse Shaper Enable Shared Shaper and select HTTP from the dropdown menu.

Enable this policy Enable this policy.

4. Select OK.
5. On the policy list page, move the FTP traffic shaping policy to the top of the list by clicking on the far left column to

drag and drop it. The HTTP traffic shaping policy should be below the FTP policy, and more general internet
access policies should be at the bottom of the policy list.

To configure the FTP and HTTP shapers - CLI:

config firewall shaper traffic-shaper
edit FTP

set maximum-bandwidth 500
set guaranteed-bandwidth 10
set per-policy enable
set priority low

next
edit HTTP

set maximum-bandwidth 200
set guaranteed-bandwidth 100
set per-policy enable
set priority medium

end

To add each shaper to a traffic shaping policy- CLI:

config firewall shaping-policy
edit 1 <shaping policy ID number>

set srcaddr all
set dstaddr all
set service ALL
set dstintf wan1 <outgoing interface>
set traffic-shaper FTP

next
edit 2 <shaping policy ID number>

set srcaddr all
set dstaddr all
set service ALL
set dstintf wan1 <outgoing interface>
set traffic-shaper HTTP

next
move 1 before 2
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end

QoS using priority from ToS or differentiated services
Configurations implementing QoS using the priority values defined in either global or specific ToS bit values are
not capable of applying bandwidth limits and guarantees, but are capable of prioritizing traffic at per-packet
levels, rather than uniformly to all services matched by the security policy.

In addition to configuring traffic prioritization, you may also choose to limit bandwidth being received by each
interface. This can sometimes be useful in scenarios where you want to limit traffic levels, but do not want to
configure traffic shaping within a security policy. This has the benefit of policing traffic at a point before the
FortiGate unit performs most processing.

Note that if you implement QoS using ToS octet rather than security policies, the FortiGate unit applies QoS on a
packet by packet basis, and priorities may be different for packets and services controlled by the same security
policy. This is more granular control than prioritization by security policies, but has the drawbacks that quality of
service is may not be uniform for multiple services controlled by the same security policy, packets will only use up
to three of the six possible queues (queue 0 to queue 2), and bandwidth cannot be guaranteed. Other devices in
your network must also be able to set or preserve ToS bits.

In this example, we limit the bandwidth accepted by each source interface, and then configure prioritized queuing
on the destination interface based upon the value of the ToS bit located in the IP header of each accepted
packet.

To limit bandwidth accepted by an interface, in the CLI, enter the following commands:

config system interface
edit <name_str>

set inbandwidth <rate_int>
next

end

where <rate_int> is the bandwidth limit in Kb/s. Excess packets will be dropped.

To configure priorities, in the CLI, configure the global priority value using the following commands:

config system global
set tos-based-priority {high | low | medium}

end

where high has a priority value of 0 and low is 2.

If you want to prioritize some ToS bit values differently than the global ToS-based priority, configure the priority
for packets with that ToS bit value using the following commands:

config system tos-based-priority
edit <id_int>

set tos [0-15]
set priority {high | low | medium}

next
end

where and tos is the value of the ToS bit in the packet’s IP header, and high has a priority value of 0 and low is
2. Priority values configured in this location will override the global ToS-based priority.
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Sample configuration

This sample configuration limits ingressing bandwidth to 500 Kb/s. It also queues egressing traffic based upon
the ToS bit in the IP header of ingressing packets.

Unless specified for the packet’s ToS bit value, packets use the low priority queue (queue 2). For ToS bit values 4
and 15, the priorities are specified as medium (value 1) and high (value 0), respectively.

config system interface
edit wan1

set inbandwidth 500
next

end
config system global

set tos-based-priority low
end
config system tos-based-priority

edit 4
set tos 4
set priority medium

next
edit 15

set tos 15
set priority high

next
end

Example setup for VoIP
In this example, there are three traffic shaping requirements for a network:

l Voice over IP (VoIP) requires a guaranteed, high-priority for bandwidth for telephone communications.
l FTP bursts must be contained so as not to consume any available bandwidth. As such this traffic needs to be

throttled to a smaller amount.
l A consistent bandwidth requirement is needed for all other email and web-based traffic.

To enable this requirement, you need to create three separate shapers and three traffic shaping policies for each
traffic type.

In this example, the values used are not recommended values.

Creating the traffic shapers

First create the traffic shapers that define the maximum and guaranteed bandwidth. The shared shapers will be
used with some applied per-policy and some applied to all policies, to better control traffic.

VoIP shaper

The VoIP functionary is a key component to the business as a communication tool and as such requires a
guaranteed bandwidth. This shaper will be a high priority shaper.

To create a VoIP shaper - web-based manager:

1. Go to Policy & Objects > Traffic Shapers and select Create New.
2. Set the Type to Shared.
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3. Enter the Name voip.
4. Set the Traffic Priority to High.
5. Select Maximum Bandwidth and enter 1000 Kb/s.
6. Select Guaranteed Bandwidth and enter 800 Kb/s.
7. Select OK.
8. Select the HTTP shaper, right-click it, and select Edit in CLI. Type the following command: 

set per-policy
end

To create a VoIP shaper - CLI:

config firewall shaper traffic-shaper
edit voip

set maximum-bandwidth 1000
set guaranteed-bandwidth 800
set per-policy enable
set priority high

end

Setting the shaper to per-policy ensures that regardless of the number of policies that use this shaper, the
defined bandwidth will always be the same. At the same time, the bandwidth is continually guaranteed at 800
Kb/s but if available can be as much as 1000 Kb/s. Setting the priority to high ensures that the FortiGate unit
always considers VoIP traffic the most important.

FTP shaper

The FTP shaper sets the maximum bandwidth to use to avoid sudden spikes by sudden uploading or
downloading of large files, and interfering with other more important traffic.

To create a FTP shaper - web-based manager:

1. Go to Policy & Objects > Traffic Shapers and Create New.
2. Set the Type to Shared.
3. Enter the Name ftp.
4. Set the Traffic Priority to Low.
5. Select Maximum Bandwidth and enter 200 Kb/s
6. Select Guaranteed Bandwidth and enter 200 Kb/s.
7. Select OK.

To create a FTP shaper - CLI:

config firewall shaper traffic-shaper
edit ftp

set maximum-bandwidth 200
set guaranteed-bandwidth 200
set priority low

end
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For this shaper, the maximum and guaranteed bandwidth are set low and to the same value. In this case, the
bandwidth is restricted to a specific amount. Setting the traffic priority low ensures that more important traffic will
be able to pass before FTP traffic.

Regular traffic shaper

The regular shaper sets the maximum bandwidth and guaranteed bandwidth for everyday business traffic such as
web and email traffic.

To create a regular shaper - web-based manager:

1. Go to Policy & Objects > Traffic Shapers and Create New.
2. Set the Type to Shared.
3. Enter the Name daily_traffic..
4. Set the Traffic Priority toMedium.
5. Select Maximum Bandwidth and enter 600 Kb/s
6. Select Guaranteed Bandwidth and enter 600 Kb/s.
7. Select OK.

To create a regular shaper - CLI:

config firewall shaper traffic-shaper
edit daily_traffic

set maximum-bandwidth 600
set guaranteed-bandwidth 600
set per-policy enable
set priority medium

end

For this shaper, the maximum and guaranteed bandwidth are set to a moderate value of 600 Kb/s. It is also set
for per policy, which ensures each security policy for day-to-day business traffic has the same distribution of
bandwidth.

Creating Traffic Shaping Policies

To employ the shapers,create traffic shaping policies that apply to your existing security policy. Create a separate
policy for each service and apply the shaper to the outgoing interface you would like to use. For example, a policy
for FTP traffic, a policy for SIP and so on.

For the following steps the VoIP traffic shaper is enabled as well as the reverse direction. This ensures that return
traffic for a VoIP call has the same guaranteed bandwidth as the outgoing call. The example below shows how to
enable each traffic shaper in a traffic shaping policy.

In this example, the traffic shaping policies will apply shaping to the following security policy:

Incoming interface lan (Internal interface)

Source address All

Outgoing interface WAN1
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Destination address All

Schedule always

Service all

Action ACCEPT

To create a VOIP traffic shaping policy- web-based manager:

1. Go to Policy & Objects > Traffic Shaping Policy and select Create New.
2. Now create a traffic shaping policy that matches the settings you entered for your security policy:

Source All

Destination All

Service All

Application Category VoIP

Application SIP

URL Category Internet Telephony

Outgoing Interface wan1

3. Enable Shared Shaper, select the voip shaper created in the previous steps.
4. Enable Reverse Shaper, select the voip shaper created in the previous steps.
5. Select Enable this policy.
6. Select OK.

To create a VOIP traffic shaping policy- CLI:

config firewall shaping-policy
edit 1 <shaping policy ID number>

set srcaddr all
set dstaddr all
set service ALL
set application 34640 <SIP>
set app-category 3 <VoIP>
set url-category 76 <Internet Telephony>
set dstintf wan1 <outgoing interface>
set traffic-shaper voip <high priority custom shaper>
set reverse-traffic-shaper voip <high priority custom shaper>

end

To create an FTP traffic shaping policy- web-based manager:

1. Go to Policy & Objects > Traffic Shaping Policy and select Create New.
2. Now create a traffic shaping policy that matches the settings you entered for your security policy:
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Source All

Destination All

Service FTP

Outgoing Interface wan1

3. Enable Shared Shaper, select the FTP shaper created in the previous steps.
4. Enable Reverse Shaper, select the FTP shaper created in the previous steps.
5. Select Enable this policy.
6. Select OK.

To create an FTP traffic shaping policy- CLI:

config firewall shaping-policy
edit 2 <shaping policy ID number>

set srcaddr all
set dstaddr all
set service FTP
set dstintf wan1 <outgoing interface>
set traffic-shaper FTP <low priority custom shaper>
set reverse-traffic-shaper FTP <low priority custom shaper>

end

To create a Regular traffic shaping policy- web-based manager:

1. Go to Policy & Objects > Traffic Shaping Policy and select Create New.
2. Now create a traffic shaping policy that matches the settings you entered for your security policy:

Source All

Destination All

Service ALL

Outgoing Interface wan1

3. Enable Shared Shaper, select the medium-priority shaper.
4. Enable Reverse Shaper, select the medium-priority shaper.
5. Select Enable this policy.
6. Select OK.

To create a Regular traffic shaping policy- CLI:

config firewall shaping-policy
edit 3 <shaping policy ID number>

set srcaddr all
set dstaddr all
set service ALL
set dstintf wan1 <outgoing interface>
set traffic-shaper medium-priority <default shaper>
set reverse-traffic-shaper medium-priority <default shaper>
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end

To order your traffic shaping policies- CLI:

config firewall shaping-policy
move 1 before 2
move 3 below 2
end

Ensure that your high priority SIP/VoIP policy is at the top of the policy list, the low
priority FTP shaper comes second, and the medium priority regular-traffic shaper
comes last. Restrictive policies should always go above more general access policies.

Alternate Method of enabling traffic shaping in the security policy

It is also possible to create three separate security policies for each type of traffic (VoIP, FTP, and regular). You
can enable traffic shaping individually within each security policy in the CLI only, like the example shown below:

To enable traffic shaping in the security policy - CLI:

config firewall policy
edit 6

set srcintf <internal_interface>
set scraddr all
set dstintf wan1
set dstaddr all
set action accept
set schedule always
set service sip
set traffic-shaper voip
set reverse-traffic-shaper voip

end
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Troubleshooting traffic shaping

This chapter outlines some troubleshooting tips and steps to diagnose the shapers and whether they are working
correctly. These diagnose commands include:

l diagnose sys tos-based-priority

l diagnose firewall shaper traffic-shaper

l diagnose firewall per-ip-shaper

l diagnose debug flow

Interface diagnosis
To optimize traffic shaping performance, first ensure that the network interface’s Ethernet statistics are clean of
errors, collisions, or buffer overruns. To check the interface, enter the following diagnose command to see the
traffic statistics:

diagnose hardware deviceinfo nic <port_name>

Shaper diagnose commands
There are specific diagnose commands you can use to verify the configuration and flow of traffic, including packet
loss due to the employed shaper.

All of these diagnose troubleshooting commands are supported in both IPv4 and IPv6.

ToS command

Use the following command to list command to view information of the ToS lists and traffic.

diagnose sys tos-based-priority

This example displays the priority value currently correlated with each possible ToS bit value. Priority values are
displayed in order of their corresponding ToS bit values, which can range between 0 and 15, from lowest ToS bit
value to highest.

For example, if you have not configured ToS-based priorities, the following appears...

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

...reflecting that all packets are currently using the same default priority, high (value 0).

If you have configured a ToS-based priority of low (value 2) for packets with a ToS bit value of 3, the following
appears...

0 0 0 2 0 0 0 0 0 0 0 0 0 0 0 0

...reflecting that most packets are using the default priority value, except those with a ToS bit value of 3.

Shared shaper

To view information for the shared traffic shaper for security policies enter the command

diagnose firewall shaper traffic-shaper list
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The resultant output displays the information on all available shapers. The more shapers available the longer the
list. For example:

name Throughput
maximum-bandwidth 1200000 Kb/sec
guaranteed-bandwidth 50000 Kb/sec
current-bandwidth 0 B/sec
priority 1
packets dropped 0

Additional commands include:

diagnose firewall shaper traffic-shaper state - provides the total number of traffic shapers on
the FortiGate unit.

diagnose firewall shaper traffic-shaper stats - provides summary statistics on the shapers.
Sample output looks like the following:
shapers 9 ipv4 0 ipv6 0 drops 0

Per-IP shaper

To view information for the per-IP shaper for security policies enter the command

diagnose firewall shaper per-ip-shaper list

The resultant output displays the information on all available per-IP shapers. The more shapers available the
longer the list. For example:

name accounting_group
maximum-bandwidth 200000 Kb/sec
maximum-concurrent-session 55
packet dropped 0

Additional commands include:

diagnose firewall shaper per-ip-shaper state - provides the total number of per-ip shapers on
the FortiGate unit.

diagnose firewall shaper per-ip-shaper stats - provides summary statistics on the shapers.
Sample output looks like the following:
memory allocated 3 packet dropped: 0

You can also clear the per-ip statistical data to begin a fresh diagnoses using:

diagnose firewall shaper per-ip-shaper clear

Packet loss with statistics on shapers

For each shaper there are counters that allow to verify if packets have been discarded. To view this information,
in the CLI, enter the command diagnose firewall shaper. The results will look similar to the following output:

diagnose firewall shaper traffic-shaper list
name limit_GB_25_MB_50_LQ
maximum-bandwidth 50 Kb/sec
guaranteed-bandwidth 25 Kb/sec
current-bandwidth 51 Kb/sec
priority 3
dropped 1291985
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The diagnose command output is different if the shapers are configured either per-policy or shared between
policies.

For per-IP the output would be:

diagnose firewall shaper per-ip-shaper list

name accounting_group
maximum-bandwidth 200000 Kb/sec
maximum-concurrent-session 55
packet dropped 3264220

Packet lost with the debug flow
When using the debug flow diagnostic command, there is a specific message information that a packet has
exceed the shaper limits and therefor discarded:

diagnose debug flow show console enable
diagnose debug flow filter addr 10.143.0.5
diagnose debug flow trace start 1000

id=20085 trace_id=11 msg="vd-root received a packet(proto=17, 10.141.0.11:3735-
>10.143.0.5:5001) from port5."

id=20085 trace_id=11 msg="Find an existing session, id-0000eabc, original direction"
id=20085 trace_id=11 msg="exceeded shaper limit, drop"

Session list details with dual traffic shaper
When a Security Policy has a different traffic shaper for each direction, it is reflected in the session list output
from the CLI:

diagnose sys session list

session info: proto=6 proto_state=02 expire=115 timeout=3600 flags=00000000 sock
flag=00000000 sockport=0 av_idx=0 use=4
origin-shaper=Limit_25Mbps prio=1 guarantee 25600/sec max 204800/sec traffic 48/sec
reply-shaper=Limit_100Mbps prio=1 guarantee 102400/sec max 204800/sec traffic 0/sec
ha_id=0 hakey=44020
policy_dir=0 tunnel=/
state=may_dirty rem os rs
statistic(bits/packets/allow_err): org=96/2/1 reply=0/0/0 tuples=2
orgin->sink: org pre->post, reply pre->post dev=2->3/3->2 gwy=10.160.0.1/0.0.0.0
hook=pre dir=org act=dnat 192.168.171.243:2538->192.168.182.110:80(10.160.0.1:80)
hook=post dir=reply act=snat 10.160.0.1:80->192.168.171.243:2538(192.168.182.110:80)
pos/(before,after) 0/(0,0), 0/(0,0)
misc=0 policy_id=2 auth_info=0 chk_client_info=0 vd=0 serial=00011e81 tos=ff/ff app=0

dd_type=0 dd_rule_id=0

Additional Information
l Packets discarded by the shaper impact flow-control mechanisms like TCP. For more accurate testing results prefer

UDP protocol.
l Traffic shaping accuracy is optimum for security policies without a protection profile where no FortiGate content

inspection is processed.
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l Do not oversubscribe an outbandwith throughput. For example, sum[guaranteed BW] < outbandwith. For accuracy
in bandwidth calculation, it is required to set the “outbandwidth” parameter on the interfaces. For more information
see Bandwidth guarantee, limit, and priority interactions on page 3175.

l The FortiGate unit is not prioritizing traffic based on the DSCPmarking configured in the security policy. However,
ToS based prioritizing can be made at ingress. For more information see Traffic shaping methods on page 3183.
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Transparent mode

This guide explains how to use a FortiGate in Transparent Mode. It includes the following sections:

l Introduction to Transparent Mode: an overview of Transparent mode, including available features.
l Transparent Mode Installation: instructions for installing a FortiGate in Trnasparent mode.
l Networking in Transparent Mode: how networking is configured in Transparent mode.
l Firewalls and Security in Transparent Mode: information about using firewalls and security scanning in Transparent

mode.
l IPsec VPN in Transparent Mode: configuring IPsec VPNs using FortiGates in Transparent mode.
l Using FortiManager and FortiAnalyzer: using external management and logging.
l High Availability in Transparent Mode: configuring Transparent FortiGates in HAmode.
l Best Practices: the best practices for using Transparent mode.
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What's new in FortiOS 5.6

The following new features have been added for Transparent Mode in FortiOS 5.6:

Using the Management IP address to populate pac-file-url
You can now use the Management IP address to populate pac-file-url in Transparent Mode. Previously,
only the interface IP could be used.

CLI syntax

config vdom
edit root
config system settings

set opmode transparent
set manageip 192.168.0.34/24

end
config web-proxy explicit

set pac-file-server-status enable
get pac-file-url [url.pac]

end
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This section contains a basic overview of Transparent mode, as well as a chart showing features available in
Transparent mode.

What is Transparent Mode?
A FortiGate unit can operate in one of two modes: Transparent or NAT mode.

In Transparent mode, the FortiGate is installed between the internal network and the router. In this mode, the
FortiGate does not make any changes to IP addresses and only applies security scanning to traffic. When a
FortiGate is added to a network in Transparent mode, no network changes are required, except to provide the
FortiGate with a management IP address. Transparent mode is used primarily when there is a need to increase
network protection but changing the configuration of the network itself is impractical.

In NAT mode, a FortiGate unit is installed as a gateway or router between two networks. This allows the
FortiGate to hide the IP addresses of the private network using network address translation (NAT).

Transparent Mode Features
Different FortiOS features are available depending on whether your FortiGate is in Transparent or NAT mode.
The following table shows which features are available for each mode.

For a FortiGate in Transparent mode, the maximum number of Interfaces
per VDOM is 254. This value includes both physical and virtual interfaces.

Feature/capability NAT Transparent Comment

Unicast Routing / Policy
Based routing

YES NO

VIP / IP pools / NAT YES YES Configurable from CLI only in
transparent mode

Multicast routing YES NO - Options
available to forward
multicast packets

L2 forwarding NO YES

In Transparent mode, other
frames than IP can be
forwarded but with no UTM
processing.

Firewall (packet filtering / NAT
/ Authentication)

YES YES
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Feature/capability NAT Transparent Comment

IPv6 capable YES YES

Traffic shaping - TOS
classification

YES YES

Hardware acceleration YES YES

All Security profile features (ex
IPS, Application Control, Web
Filtering, etc ...)

YES YES

Security Fabric YES NO

FortiView YES YES

IPsec gateway YES YES - Policy based
mode only

SSL gateway YES NO

High-Availability (HA) - Virtual
Cluster YES YES

802.3ad (LACP / port
aggregation)

YES YES

HA port redundancy YES YES FortiGate hardware
dependent

802.1q - VLAN trunking YES YES

802.1d - Spanning Tree NO NO - option to
forward BPDUs

Logging and reporting (disk
and memory logging,
FortiCloud, syslog, and
FortiAnalyzer)

YES YES

Managed by FortiManager YES YES
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This section contains information about installing a FortiGate in Transparent mode and using a virtual wire pair,
to simplify Transparent mode. It also contains information about configuring the FortiGate's management IP.

Installing a FortiGate in Transparent mode

Changing to Transparent mode removes most configuration changes made in NAT
mode. To keep your current NAT mode configuration, backup the configuration using
the System Information widget, found in the Dashboard.

1. Before connecting the FortiGate unit to your network, go to the Dashboard and locate enter the following
command into the CLI Console:

config system settings
set opmode transparent
set manageip <address and netmask>
set gateway <address>

end

2. Access the web-based manager by browsing to the new management IP.
3. (Optional) The FortiGate unit’s DNS Settings are set to use FortiGuard DNS servers by default, which is sufficient

for most networks. However, if you need to change the DNS servers, go to Network > DNS and add Primary and
SecondaryDNS servers. Select Apply.

4. If your network uses IPv4 addresses, go to Policy & Objects > IPv4 Policy and select Create New to add a
security policy that allows users on the private network to access the Internet.

If your network uses IPv6 addresses, go to Policy & Objects > IPv6 Policy and select Create New to add a
security policy that allows users on the private network to access the Internet. If the IPv6 menu option is not
available, go to System > Feature Visibility, turn on IPv6, and select Apply. For more information on IPv6
networks, see the IPv6 Handbook.

Set the Incoming Interface to the internal interface and theOutgoing Interface to the Internet-facing interface
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(typically WAN1). You will also need to set Source Address, Destination Address, Schedule, and Service
according to your network requirements. You can set these fields to the default all/ALL settings for now but should
create the appropriate objects later after the policies have been verified.

5. Make sure the Action is set to ACCEPT. Select OK.

It is recommended to avoid using any security profiles, such as AntiVirus or web
filtering, until after you have successfully installed the FortiGate unit. After the
installation is verified, you can apply any required security profiles.

For more information about using security profiles, see the Security Profiles handbook.

6. Go to the Dashboard and locate the System Resources widget. Select Shutdown to power off the FortiGate
unit.
Alternatively, you can also use the CLI command execute shutdown.

7. Connect the FortiGate unit between the internal network and the router.
8. Connect the Internet-facing interface to the router’s internal interface and connect the internal network to the

FortiGate using an internal port (typically port 1).
9. Power on the FortiGate unit. You will experience downtime before the FortiGate unit starts up completely.

Results

Users on the internal network are now able to browse to the Internet. They should also be able to connect to the
Internet using any other protocol or connection method that you defined in the security policy.

If a FortiGate unit operating in Transparent mode is installed between your internet
network and a server that is providing a network service to the internal network, such
as DNS or DHCP, you must add a wan1-to-internal policy to allow the server’s
response to flow through the FortiGate unit and reach the internal network.

Using a Virtual Wire Pair to Simplify Transparent Mode

A virtual wire pair consists of two interfaces that have no IP addresses and all traffic received by one interface in
the pair can only be forwarded out the other; as controlled by firewall policies. Since the interfaces do not have IP
addresses, you can insert a virtual wire pair into a network without having to make any changes to the network. A
virtual wire pair can include redundant and 802.3ad aggregate (LACP) interfaces.
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Interfaces used in a virtual wire pair cannot be used for admin access to the ISFW
FortiGate. Before creating a virtual wire pair, make sure you have a different port
configured to allow admin access using your preferred protocol.

1. Go to Network > Interfaces and select Create New > Virtual Wire Pair. Add two ports to the virtual wire pair.
These ports cannot be part of a switch, such as the default internal/lan interface.

2. Go to Policy & Objects > IPv4 Virtual Wire Pair Policy and create a policy will allow traffic to flow between
the two ports. Give the policy an appropriate Name. Select the direction that traffic is allowed to flow. Configure
the other firewall options as needed.

3. If necessary, create a second virtual wire pair policy allowing traffic to flow between the ports in the opposite
direction.

Traffic can now flow between the two ports. Go to FortiView > Policies to see traffic flowing through both
policies.

Management IP configuration
A FortiGate in Transparent mode can be assigned with a single IP address for remote access management and
multiple static routes can be configured. This can be used if in-band management wants to be applied.

When out-of-band management is desired (dedicated interface for remote management access), it is
recommended to use a separate VDOM in NAT mode.

In-band management details and example

The management IP address is bound to all ports or VLANs belonging to the same VDOM. Remote access
services are subject to the same rules as in NAT mode, and must be enabled/disabled on each port.

Example of management IP configuration in Transparent mode:

config system settings
set manageip 10.1.1.100/255.255.255.0

end
config router static

edit 1
set gateway 10.1.1.254

next
end
config system interface

edit port1
set allowaccess ping ssh https snmp

end

It is also possible to add a second IP address for management and additional default routes:

config system settings
set opmode transparent
set manageip 192.168.182.136/255.255.254.0 10.1.1.1/255.255.255.0

end

config router static
edit 1
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set gateway 192.168.183.254
next
edit 2

set gateway 10.1.1.254
next

end

ping-server (dead gateway detection) is not supported in Transparent mode.

Out-of-band management details and example

When VDOM is enabled and the VDOMs are operating in Transparent mode, it is recommended, to avoid L2
loops and allow more routing flexibility, to keep one VDOM (generally the root VDOM) in NAT mode, with one or
more VLAN or physical interface as out-of-band management.

The management VDOM must have IP connectivity to the Internet to allow
communication with the FDS and retrieve services information (AV,IPS, Fortiguard
filtering, Support…). All syslog and FortiManager communication also go through the
management VDOM.
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This section contains information about networking concepts in Transparent mode. It contains the following
topics:

l Packet Forwarding
l Network Address Translation (NAT)
l VLANs and Forwarding Domains
l Inter-VDOM links between NAT and Transparent VDOMs
l Packet Forwarding using Cisco Protocols
l Configuration Example

Packet Forwarding
The following sections include information aboutconfiguring packet forwarding in Transparent mode:

l MAC learning and L2 Forwarding Table
l Broadcast, Multicast, and Unicast Forwarding
l Multicast Processing
l Source MAC Addresses
l ARP Table
l Verifying the Forwarding Database
l Spanning Tree BPDUs Forwarding
l Non-IPv4 Ethernet frames forwarding

MAC learning and L2 Forwarding Table

When operating in Transparent mode, a FortiGate behaves like an L2 switch in accordance with 802.1d
principles:

l The forwarding database (FDB) is populated with the network devices MAC addresses during a MAC learning
process, based on the source addresses seen in the Ethernet frames ingressing a FortiGate port. Static MAC
entries can also be configured using the following CLI command:

config system mac-address-table
edit 00:01:02:03:04:05

set interface "port3"
next

end

The FDB table can be verified with the following command: diagnose netlink
brctl name host TP.b

l Ethernet IP frames forwarding is based on known MAC address on each port.
l As Spanning Tree in not running on the FortiGate, a port that comes up goes immediately into forwarding or

flooding state. This last state will not occur once unicast MAC addresses are present in the FDB.
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If the FortiGate in Transparent mode bridges traffic to a router or host using a virtual
MAC for one direction and a different physical MAC for the other direction (for example
when VRRP or HSRP protocols are used), it is highly recommended to create a static
MAC entry for the virtual MAC. This is to make sure that the virtual MAC address is
present in the FDB.

Broadcast, Multicast, and Unicast Forwarding

In Transparent mode, IPv4 packets are typically only forwarded by the FortiGate from a port to another port when
a firewall policy is matched with action ACCEPT.

Below are exceptions.

l L2 (IP) Broadcast frames forwarding:

L2 (IP) means a L2 frame type 0x0800 (IP) or 0x0806 (ARP)

l ARP: by default, ARP broadcasts and ARP reply packets are flooded/forwarded on all ports or VLANs
belonging to the same forwarding domain, without the need of firewall policies between the ports. This default
behavior is necessary to allow the population of the FDB and allow further firewall policy lookup (see section
Transparent mode Firewall processing for more details). This option is configurable at the interface settings
level with the parameter arpforward (enabled by default).

l Non-ARP: To forward non-ARP broadcasts, the following CLI command is used:
config system interface

edit "port2"
set broadcast-forward enable

next
end

l L2 (IP) Multicast frames forwarding: the FortiGate does not forward frames with multicast destination MAC
addresses by default. Multicast traffic such as one used by routing protocols or streaming media may need to
traverse the FortiGate which should not interfere this communication.

Fortinet recommends that the FortiGate is set up using Multicast policies. This allows for greater control and
predictability on traffic behavior. However Multicast traffic may be forwarded through a Transparent mode device
using the multicast-skip-policy setting. This is detailed in the section "Multicast Processing" on page 3229

l L2 (IP) Unicast frames forwarding: a frame with a unicast destination MAC address is subject to firewall
processing before being forwarded (see "Firewall Policy Look Up" on page 3242 for more details). This does not
apply to ARP replies.

Multicast Processing

In Transparent mode, a FortiGate does not forward frames with multicast destination MAC addresses by default.
If multicast traffic is required, multicast policies are recommended to allow finer control of this traffic.

Forwarding all multicast traffic with policy

Multicast traffic may have to be forwarded through a Transparent mode device using the multicast-skip-
policysytem setting. This is the configuration for this solution:
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config system settings
set multicast-skip-policy enable

end

In that case, no check is performed on sources/destinations/interfaces. Amulticast packet received on an
interface is flooded unconditionally to all interfaces (except the incoming interface) belonging to the same
forwarding domain.

Configuring firewall multicast-policy

The use of firewall multicast-policy allows a finer control over the multicast packets. Hereafter are
some commented examples. Note that the parameter multicast-skip-policy mentioned above must be left to
disabled.

Those policies can only be configured from the CLI.

1- Simple policy

config firewall multicast-policy
edit 1

set action accept
next

end

In that case, no check is performed on sources/destinations/interfaces. Amulticast packet received on an
interface is flooded unconditionally to all interfaces (except the incoming interface) belonging to the same
forwarding domain.

2- To restrict incoming and outgoing interfaces:

config firewall multicast-policy
edit 1

set srcintf "port1"
set dstintf "port2"
set action accept

next
end
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3- To be more restrictive (example to allow RIP2 packets from port1 to port2 and sourced by 10.10.0.10):

config firewall multicast-policy
edit 1

set srcintf "port1"
set srcaddr 10.10.0.10 255.255.255.255
set dstintf "port2"
set dstaddr 224.0.0.9 255.255.255.255
set action accept

next
end

4- This policy will allow all 224.0.0.0/255 range (OSPF, RIPv2, DVMPR…) from port1 to port2

config firewall multicast-policy
edit 1

set srcintf "port1"
set dstintf "port2"
set dstaddr 224.0.0.0 255.255.255
set action accept

next
end

Source MAC Addresses

When a FortiGate is in Transparent Mode, it does not typically alter the original source and destination address of
packets that flow through the unit. Because of this, end devices do not “see” the MAC address of the FortiGate.
However, if network address translation (NAT) is enabled by a firewall policy, the source MAC address will be the
MAC address of the FortiGate's management interface.

IP packets that are initiated by the FortiGate (remote management, access to FortiGuard server…) are sent in L2
Ethernet frames that have a source MAC address of the interface in the virtual domain (VDOM) with the lowest
MAC address. Below is an example with port2 and port3 in the same VDOM, remote access done via port3, but
the sniffer trace showing MAC address of port2. The address of port2 is shown in bold.

diagnose hardware deviceinfo nic port2
[…]
Current_HWaddr          00:09:0F:85:3F:C4
Permanent_HWaddr        00:09:0F:85:3F:C4

fgt300 (global) # diagnose hardware deviceinfo nic port3
[…]
Current_HWaddr          00:09:0F:85:3F:C5
Permanent_HWaddr        00:09:0F:85:3F:C5

diagnose sniffer packet port3 "port 80" 6
3.774236 port3 -- 192.168.171.165.2619 -> 192.168.182.136.80: syn 3961770249
0x0000   0009 0f85 3fc4 0009 0f09 3204 0800 4500      ....? .... 2...E.
0x0010   0030 8071 4000 7e06 98d7 c0a8 aba5 c0a8      .0.q@.~ ........
0x0020   b688 0a3b 0050 ec23 d109 0000 0000 7002      ...;.P.# ..... p.
0x0030   ffff d7e7 0000 0204 05b4 0101 0402

ARP Table

In Transparent mode, the Address Resolution Protocol (ARP) table is used in the following situations:
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l For IP traffic received or originated by the FortiGate itself, and in destination of the management device or next-
hop.

l When IPsec is used, the FortiGate uses its ARP table to forward the traffic from the IPsec tunnel to the local
destination host(s).

All other forwarding decision is based on the Forwarding Database (FDB) table or optional settings.

Verifying the Forwarding Database

To view all instances of the forwarding database (FDB), use the following CLI command:

diagnose netlink brctl list

Example

FGT # diagnose netlink brctl list

list bridge information
1. root.b fdb: size=256 used=6 num=7 depth=2 simple=no
2. mgmt.b fdb: size=256 used=5 num=4 depth=2 simple=no
Total 2 bridges

Here above we can see two bridge instances for 2 VDOMs in Transparent mode: root and mgmt.

l This command will dump the L2 forwarding table for each VDOM bridge instance:

diagnose netlink brctl name host <VDOM_name>.b

Example for the root VDOM:

FGT# diag netlink brctl name host root.b

show bridge control interface root.b host.
fdb: size=256, used=6, num=7, depth=2, simple=no
Bridge root.b host table
port no device devname mac addr ttl atributes

2 7 wan2 02:09:0f:78:69:00 0 Local Static
5 6 trunk_1 02:09:0f:78:69:01 0 Local Static
3 8 dmz 02:09:0f:78:69:01 0 Local Static
4 9 internal 02:09:0f:78:69:02 0 Local Static
3 8 dmz 00:80:c8:39:87:5a 194
4 9 internal 02:09:0f:78:67:68 8
1 3 wan1 00:09:0f:78:69:fe 0 Local Static

Spanning Tree BPDUs Forwarding

Spanning tree Bridge Protocol Data Units (BPDUs) are not forwarded by default in Transparent Mode. To forward
spanning tree BPDUs, the following setting can be applied on each interface where this is required:

config system interface
edit port1

set stpforward enable
next

end
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Non-IPv4 Ethernet frames forwarding

In the situation where non IP frames (or non Ethernet II) frames need to be accepted on a port, the parameter
l2forward can be enabled (disabled by default). This can be used to forward frames such as PPPoE PADI,
Appletalk, on other ports belonging to the same forwarding domain.

The procedure is the following:

config system interface
edit port1

set l2forward enable
next
edit port2

set l2forward enable
next

end

Network Address Translation (NAT)
While NAT is generally not used by a FortiGate in Transparent mode, both source network address translation
(SNAT) and destination network address translation (DNAT) can be configured.

Configuring SNAT

Source Network Address Translation (SNAT) is an option available in Transparent mode and configurable in CLI
only, using the following commands:

config firewall ippool
edit "nat-out"

set endip 192.168.183.48
set startip 192.168.183.48
set interface vlan18_p3

next
end

config firewall policy
edit 3

set srcintf "vlan160_p2"
set dstintf "vlan18_p3"
set srcaddr "all"
set dstaddr "all"
set action accept
set ippool enable
set poolname "nat-out"
set schedule "always"
set service "ALL"
set nat enable

next
end

The sniffer trace below shows the source IP 192.168.182.93 being source translated to 192.168.183.48:

fgt300 (TP) # diagnose sniffer packet any "host 10.2.2.1" 4

interfaces=[any]
filters=[host 10.2.2.1]
4.891970 vlan160_p2 in 192.168.182.93 -> 10.2.2.1: icmp: echo request
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4.892003 vlan18_p3 out 192.168.183.48 -> 10.2.2.1: icmp: echo request
4.892007 port3 out 192.168.183.48 -> 10.2.2.1: icmp: echo request
4.933216 vlan18_p3 in 10.2.2.1 -> 192.168.183.48: icmp: echo reply
4.933249 vlan160_p2 out 10.2.2.1 -> 192.168.182.93: icmp: echo reply
4.933253 port2 out 10.2.2.1 -> 192.168.182.93: icmp: echo reply

Configuring DNAT

The following example shows how to configure Destination Network Address Translation (DNAT) using a virtual
IP on a FortiGatein Transparent Mode:

config firewall vip
edit "vip1"

set extip 192.168.183.48
set extintf "vlan160_p2"
set mappedip 192.168.182.78

next
end

config firewall policy
edit 4

set srcintf "vlan160_p2"
set dstintf "vlan18_p3"
set srcaddr "all"
set dstaddr "vip1"
set action accept
set schedule "always"
set service "ALL"

next
end

If the mappedip is on a different subnet than the management IP, the FortiGate
must have a valid routeto this destination

The sniffer trace below shows the destination IP 192.168.183.48 being translated to 192.168.182.78:

fgt300 (TP) # diagnose sniffer packet any "icmp" 4

interfaces=[any]
filters=[icmp]
4.126138 vlan160_p2 in 192.168.182.93 -> 192.168.183.48: icmp: echo request
4.126190 vlan18_p3 out 192.168.182.93 -> 192.168.182.78: icmp: echo request
4.126196 port3 out 192.168.182.93 -> 192.168.182.78: icmp: echo request
4.126628 vlan18_p3 in 192.168.182.78 -> 192.168.182.93: icmp: echo reply
4.126661 vlan160_p2 out 192.168.183.48 -> 192.168.182.93: icmp: echo reply
4.126667 port2 out 192.168.183.48 -> 192.168.182.93: icmp: echo reply

VLANs and Forwarding Domains
The following sections include information about configuring virtual local area networks (VLANs) and forwarding
domains in Transparent mode:
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l VLANs in Transparent Mode
l Forwarding Domains in Transparent Mode
l VLANs vs Forwarding Domains
l VLAN Forwarding
l Unknown VLANs and VLAN Forwarding
l VLAN Trunking and MAC Address Learning
l VLAN Translation

VLANs in Transparent Mode

A VLAN configured on a physical port is used to classify a packet in a broadcast domain in ingress and to tag
packet in egress. A VLAN on the FortiGate conforms to the standard 802.1q. The following rules apply to VLAN
configuration:

l a VLAN ID can be used only once on the same physical port
l the same VLAN ID can be used on a different port
l the VLAN ID range is from 1 to 4094

Forwarding Domains in Transparent Mode

A forwarding domain is used to create separate broadcast domains and confine traffic across two or more ports. It
also allows learning the same MAC in different VLANs (IVL).

A forwarding domain and its associated ID number are unique across one VDOM, or a FortiGate with VDOMs
disabled. Each new VDOM will create a new bridge instance in the FortiGate.

Even though the forwarding domain ID is not in relation with the actual
VLAN numbers, it is recommended, for maintenance and troubleshooting
purposes, to configure one forwarding domain per VLAN and use the same
forwarding domain ID as the VLANs ID.

Once forwarding domains are configured, it is possible to configure firewall
policies only between ports or VLAN belonging to the same forwarding
domain.
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Example configuration

This example has three forwarding domains and VLANs configured. In this example, there are two VDOMs in
Transparent Mode: root and MGMT. Forwarding domain 0 is the default on the FortiGate or VDOM in
Transparent Mode.

l Root VDOM has:
l 3 forwarding domains, 0, 340, and 341.
l VLAN 340 configured on port1; packets will be tagged with ID 340
l VLAN 341 configured on port1; packets will be tagged with ID 341
l All other ports are untagged

l MGMT VDOM has got only the default forwarding domain 0

The expected behavior is the following:

l Packets untagged ingressing port1, port3 and port4 belong to the same broadcast domain in the root VDOM
l Packets tagged with VLAN 340 ingressing port1 and Packets untagged ingressing port2 belong to the same

broadcast domain in the root VDOM
l Packets tagged with VLAN 341 ingressing port1 and Packets untagged ingressing port5 belong to the same

broadcast domain in the root VDOM
l Packets untagged ingressing port6 belong to a different broadcast domain in the MGMT VDOM

CLI Syntax for forwarding domain 340

config system interface
edit "VLAN340"

set forward-domain 340
set interface "port1"
set vlanid 340

next
edit "port3"

set forward-domain 340
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next
end

VLANs vs Forwarding Domains

There are several differences between VLAN and a forwarding domain configured on a FortiGate in Transparent
Mode:

l A forwarding domain is used to create separated broadcast domains between VLANs and allow independent VLAN
learning - IVL (MAC addresses in the FDB). This would be equivalent to creating VLANs on a regular L2 switch.

When VLANs are used in the network, configuring different forwarding
domains is essential to avoid broadcast duplications. See also section
Default VLAN forwarding behavior for additional information.

l VLANs configured on interfaces are only used for tagging packets egressing the port and classifying packets at
ingress.

l The packets processed by the direct interface (or port) itself are always sent untagged and must be received
untagged.

VLAN Forwarding

VLAN forwarding allows you to forward all VLANs traffic of a trunk that was connecting two network devices and
where the FortiGate has been introduced, without having to perform any further configuration.

It is recommended to configure forwarding domains for each VLAN and disable this parameter in order to avoid
packet from looping into the trunk from one VLAN to another. By default, the parameter vlanforward is
disabled on each physical interface of a FortiGate or VDOM in Transparent mode.

Unknown VLANs and VLAN Forwarding

When a FortiGate receives a tagged frame with an unknown VLAN ID, traffic can be handled one of two ways,
depending on whether VLAN forwarding is enabled or disabled.

By default, VLAN forwarding is disabled and any frames that are tagged with an unknown VLAN ID are dropped
by the FortiGate.

If you enable VLAN forwarding, frames tagged with an unknown VLAN ID are forwarded from the port that
received the frames to all other ports in the same forwarding domain(s). This allows you to insert the FortiGate
between two devices using trunk ports without any further configuration.

VLAN Trunking and MAC Address Learning

A FortiGate port becomes a trunk when 2 or more VLANs are configured on this port, in the same or different
forwarding domains.

When trunks are configured on a FortiGate, it is essential to create forwarddomains, in
order to avoid packets looping back on the VLANs of the trunk. This will confine all
broadcasts and multicast traffic between the interfaces belonging to a same forward
domain.
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In the case where a trunk port is configured with a VLAN in a different forwarding domains, the MAC address of
the network device connected to this port learns the FDB of each forwarding domain. This is Independent VLAN
Learning (IVL).

VLAN Translation

The same forwarding domain can include several different VLANs. Therefore, a frame ingressing an interface
with a certain VLAN ID can be forwarded to another port with another VLAN ID. This is sometimes referred as
VLAN translation.

Inter-VDOM links between NAT and Transparent VDOMs
Inter-VDOM links between NAT and Transparent mode VDOMS can be useful for configurations where the NAT
VDOMs that share a common Internet service route, which can be routed through a Transparent VDOM that
provides additional functionality, like common Security inspection, WAN optimization, explicit proxying and so on.

Other examples include:

l Performing SSL offloading in the Transparent mode VDOM and providing Internet access through a NAT mode
VDOM.

l Applying WAN optimization in a Transparent mode VDOM and other security features in the NAT mode VDOM.
l Using a dedicated Transparent mode VDOM for the explicit web proxy in front of a NAT mode VDOM that applies

other security features.
l An ISP configuration with multiple per-tenant NAT mode VDOMs all sharing a single Internet connection but where

the ISP only presents a single routed subnet. Each tenant can then be assigned an IP from the subnet for their
respective VDOM link interface while using a single physical port to connect to the ISP router.

For more information about inter-VDOM links, please refer to the Virtual Domains handbook.

Replay Traffic Scenario
Situations can arise where an identical TCP packet enters twice the FortiGate via 2 different ports. This can be
due to a firewall or other network device redirecting packets out on the same port it has received it.

The FortiGate will in this condition detect a replay packet and drop it.

If the network topology or culprit devices cannot be changed to avoid this, the workaround on the FortiGate can
be to disable TCP replay verification packets.

config system global
set anti-replay | loose | strict | disable |

end

The debug flow diagnosis output hereafter shows the message indicating this condition:

id=20085 trace_id=179 msg="vd-VDOM_VLAN1 received a packet(proto=6, 10.10.253.9:10709
>10.10.248.5:25) from TO_EXTERNAL ."
id=20085 trace_id=179 msg="Find an existing session, id-00041475, original direction"
id=20085 trace_id=179 msg="replay packet, drop"

For additional diagnosis and troubleshooting procedures,go to http://kb.fortinet.com.
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Packet Forwarding using Cisco Protocols
In order to pass Cisco Discover Protocol (CDP) or Cisco VLAN Trunk Protocol (VTP) packets through a FortiGate
in Transparent mode, the parameter stpforward must be applied on the port configuration. VTP and CDP
packets are sent to the destination MAC address 01-00-0C-CC-CC-CC.

A Cisco NATIVE VLAN carries CDP/VTP frames. The frames of this VLANmust be
received on the FortiGate physical interfaces (not VLAN sub-interface). Physical
interfaces are the only ones that can send/accept non-tagged packets.

The example below will allow CDP and VTP packets to be sent from port3 up to the Remote unit, through two
VDOMs, via one physical port and three port aggregations.

Port and Port aggregation configuration:

config system interface
edit "port1"

set vdom "VD1"
next
edit "port2"

set vdom "VD1"
next
edit "port3"

set vdom "VD1"
set stpforward enable

next
edit "port5"

set vdom "VD3"
next
edit "port6"

set vdom "VD3"
next
edit "port17"

set vdom "VD2"
next
edit "port18"

set vdom "VD2"
next
edit "port19"

set vdom "VD2"
next
edit "port20"

set vdom "VD2"
next
edit "LACP_VD2_IN"

set vdom "VD2"
set stpforward enable
set type aggregate

set member "port17" "port18"
next
edit "LACP_VD2_OUT"

set vdom "VD2"
set stpforward enable
set type aggregate
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set member "port19" "port20"
next
edit "LACP_VD1"

set vdom "VD1"
set stpforward enable
set type aggregate

set member "port1" "port2"
next

end

When using aggregation, the stpforward setting needs to be applied
only on the port aggregation level, not on the physical port

This will also forward regular Spanning Tree BPDUs

Verification with a sniffer trace:

FGT# diagnose sniffer packet any "" 4

41.365434 port3 in llc unnumbered, ui, flags [command], length 72
41.365437 LACP_VD1 out llc unnumbered, ui, flags [command], length 72
41.365439 port2 out llc unnumbered, ui, flags [command], length 72
41.365479 LACP_VD2_IN in llc unnumbered, ui, flags [command], length 72
41.365482 LACP_VD2_OUT out llc unnumbered, ui, flags [command], length 72
41.365484 port19 out llc unnumbered, ui, flags [command], length 72

See above the CDP packet flow from port3, LACP_VD1 (port2), LACP_VD2_IN, LACP_VD2_OUT (port19).

The following sniffer trace command will filter only CDP or VTP packets :

FGT# diagnose sniffer packet port_name "ether host 01-00-
0C-CC-CC-CC"

Configuration Example

Step 1: Create VLANs and forwarding domains
config system interface

edit "vlan102_intern"
set forward-domain 102
set interface "port2"
set vlanid 102

next
edit "vlan102_extern"
set forward-domain 102
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set interface "port3"
set vlanid 102

next
edit "vlan103_intern"
set forward-domain 103
set interface "port2"
set vlanid 103

next
edit "vlan103_extern"
set forward-domain 103
set interface "port3"
set vlanid 103

next
end

Step 2: Create the appropriate Firewall Policies
config firewall policy

edit 1
set srcintf "vlan102_extern"
set dstintf "vlan102_intern"

set srcaddr "all"
set dstaddr "all"

set action accept
set schedule "always"
set service "ALL" next

edit 2
set srcintf "vlan102_intern"
set dstintf "vlan102_extern"

set srcaddr "all"
set dstaddr "all"

set action accept
set schedule "always"
set service "ALL" next

edit 3
set srcintf "vlan103_intern"
set dstintf "vlan103_extern"

set srcaddr "all"
set dstaddr "all"

set action accept
set schedule "always"
set service "ALL" next

edit 4
set srcintf "vlan103_extern"
set dstintf "vlan103_intern"

set srcaddr "all"
set dstaddr "all"

set action accept
set schedule "always"
set service "ALL" next

end
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This section contains information about using firewalls and security scanning in Transparent mode. It contains
the following topics:

l Firewall Policy Look Up
l Firewall Session List
l Security Scanning

Firewall Policy Look Up
In Transparent mode, like in NAT mode, a firewall policy look up is based on the source and destination
interfaces. The matching firewall policy will tell which actions to apply to the traffic, including logging and security
scanning.

The FortiGate proceeds as follows to look for a matching firewall policy in Transparent mode:

l Step 1: an Ethernet IP frame ingresses a port (or a VLAN on a port), corresponding to a specific bridge instance
(from the port VDOM and Forwarding domain). This frame contains a destination MAC address that we will call
MAC_D.

l Step 2: The FortiGate is making a MAC_D address lookup in the bridge instance to determine the port where
MAC_D has been learned. This will be the destination interface.

l Step 3: The FortiGate is then looking for a firewall policy corresponding to the couple < source interface +
destination interface >. If multiple policies with the same couple < source interface + destination interface > exist,
the FortiGate screens all of them from TOP to BOTTOM (as displayed in the configuration), until a match is found.
It is important to make sure that the most specific firewall policies are located at the top of the policy list, to make
sure that traffic is matched to the appropriate policy.

Firewall Session List
The flag br in the state line will indicate that this is a “bridged” session. See example below :

FGT# diagnose sys session list

session info: proto=17 proto_state=00 duration=59 expire=128 timeout=0 flags=000
00000 sockflag=00000000 sockport=0 av_idx=0 use=4
origin-shaper=
reply-shaper=
per_ip_shaper=
ha_id=0 hakey=0
policy_dir=0 tunnel=/
state=may_dirty br rem
statistic(bytes/packets/allow_err): org=385/5/1 reply=0/0/0 tuples=2
orgin->sink: org pre->post, reply pre->post dev=3->4/4->3 gwy=0.0.0.0/0.0.0.0
hook=pre dir=org act=noop 192.168.182.93:1025->4.2.2.1:53(0.0.0.0:0)
hook=post dir=reply act=noop 4.2.2.1:53->192.168.182.93:1025(0.0.0.0:0)
misc=0 policy_id=1 auth_info=0 chk_client_info=0 vd=1 serial=000006d3 tos=ff/ff
imp2p=0 app=0
dd_type=0 dd_rule_id=0
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Security Scanning
Security scanning occurs in the same manner in NAT mode and Transparent mode. When a protection profile is
enabled on a firewall policy for content inspection, the FortiGate acts like a transparent proxy for the protocols
that need to be inspected.

The FortiGate will therefore intercept the TCP sessions and create its own session from client to server and
server to client. The source and destination MAC addresses of the original L2 frames are however not altered in
this communication, as described in the section Network operation : source MAC addresses in frames sent by or
through the FortiGate.

Devices in the network communicating through the FortiGate do not know the
presence of the FortiGate.

For more information about security scanning, see the Security Profiles handbook.
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IPsec VPN in Transparent Mode

This section contains information about configuring IPsec virtual private networks (VPNs) in Transparent mode. It
contains the following topics:

l Using IPsec VPNs in Transparent Mode
l Example 1: Remote Sites with Different Subnets
l Example 2: Remote Sites on the Same Subnet

Using IPsec VPNs in Transparent Mode
In Transparent mode, IPsec VPN is supported in Policy-based configuration mode only.

IPsec VPN in Transparent mode can be used in those scenarios:

l Encrypt data over routed networks without changing anything on the routers. See example 1.
l Encrypt data over a non-routed transport network (extension of a LAN for example). See example 2.

The following rules apply to IPsec in Transparent mode:

l If both remote FortiGate IPsec gateways are not in the same broadcast domain (separated by routers):
l The hosts on each side must be on different subnets.
l The FortiGate management IP addresses must be in the same subnet as the local hosts. This is the preferred

option.
l If both remote FortiGate IPsec gateways are in the same broadcast domain (separated by optical switches for

examples), the hosts on each side can be :
l On the same subnet
l On different subnet if the appropriate static route is configured on the remote Fortigate
l The FortiGate management IP addresses can be in any different subnet than the local hosts

l A firewall Policy with the action IPsec is used to send traffic to the remote device into the tunnel.
Therefore, it is important to place all remote devices on the appropriate ports of the Fortigate to allow a proper
match < source interface + destination interface > . See section Transparent mode Firewall processing for more
details.

This scenario requires that the remote hosts located on the remote FortiGate’s
protected subnets have their MAC addresses hardcoded in FortiGate’s static MAC
entry list. If this is not configured then it is expected to see outage in network
communications.
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Example 1: Remote Sites with Different Subnets

This example provides a configuration example for IPsec VPN tunnels between three FortiGate in Transparent
Mode in different subnets, as well as some troubleshooting steps.

The expectation for this example is that PC1 will be able to communicate via the IPsec tunnels with PC2 and
PC3, which are in different subnets.

The requirements for this example are:

l Because both FortiGate are not in the same broadcast domain (separated by routers), the hosts on each side must
be on different subnets.

l FortiGate management IP addresses must be in the same subnet as the local hosts
l The default gateways (router1 ,router2, router3) for PC1 , PC2 and PC3 must be behind port2 in order for the

FortiGate to match the appropriate Encrypt firewall policy (port1 --> port2)

Configuration of FortiGate 1 (FGT1):

Only relevant parts of configuration are provided.

config system settings
set opmode transparent
set manageip 10.1.1.100/255.255.255.0

end

config router static
edit 1

set gateway 10.1.1.254
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next
end

config firewall address
edit "10.1.1.0/24"

set subnet 10.1.1.0 255.255.255.0
next
edit "10.2.2.0/24"

set subnet 10.2.2.0 255.255.255.0
next
edit "10.3.3.0/24"

set subnet 10.3.3.0 255.255.255.0
next

end

config vpn ipsec phase1
edit "to_FGT2"

set proposal 3des-sha1 aes128-sha1 des-md5
set remote-gw 10.2.2.100
set psksecret fortinet

next
edit "to_FGT3"

set proposal 3des-sha1 aes128-sha1 des-md5
set remote-gw 10.3.3.100
set psksecret fortinet

next
end

config vpn ipsec phase2
edit "to_FGT2"

set keepalive enable
set phase1name "to_FGT2"
set proposal 3des-sha1 aes128-sha1
set dst-subnet 10.2.2.0 255.255.255.0
set src-subnet 10.1.1.0 255.255.255.0

next
edit "to_FGT3"

set keepalive enable
set phase1name "to_FGT3"
set proposal 3des-sha1 aes128-sha1
set dst-subnet 10.3.3.0 255.255.255.0
set src-subnet 10.1.1.0 255.255.255.0

next
end

config firewall policy
edit 1

set srcintf "port1"
set dstintf "port2"
set srcaddr "10.1.1.0/24"
set dstaddr "10.2.2.0/24"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "to_FGT2"
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next
edit 3

set srcintf "port1"
set dstintf "port2"
set srcaddr "10.1.1.0/24"
set dstaddr "10.3.3.0/24"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "to_FGT3"

next
end

Configuration of FortiGate 2 (FGT2):

Only relevant parts of configuration are provided.

config system settings
set opmode transparent
set manageip 10.2.2.100/255.255.255.0

end

config router static
edit 1

set gateway 10.2.2.254
next

end

config firewall address
edit "10.1.1.0/24"

set subnet 10.1.1.0 255.255.255.0
next
edit "10.2.2.0/24"

set subnet 10.2.2.0 255.255.255.0
next

end

config vpn ipsec phase1
edit "to_FGT1"

set nattraversal disable
set proposal 3des-sha1 aes128-sha1 des-md5
set remote-gw 10.1.1.100
set psksecret fortinet

next
end

config vpn ipsec phase2
edit "to_FGT1"

set keepalive enable
set phase1name "to_FGT1"
set proposal 3des-sha1 aes128-sha1
set dst-subnet 10.1.1.0 255.255.255.0
set src-subnet 10.2.2.0 255.255.255.0

next
end
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config firewall policy
edit 1

set srcintf "port1"
set dstintf "port2"
set srcaddr "10.2.2.0/24"
set dstaddr "10.1.1.0/24"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "to_FGT1"

next
end

Troubleshooting procedure

All steps given when PC1 pings PC2.

Verify if IPsec tunnels are up

FGT1 # diagnose vpn tunnel list

list all ipsec tunnel in vd 0
------------------------------------------------------
name=to_FGT2 ver=0 serial=1 10.1.1.100:0->10.2.2.100:0 lgwy=dyn tun=tunnel mode= auto
bound_if=0
proxyid_num=1 child_num=0 refcnt=7 ilast=0 olast=0
stat: rxp=0 txp=0 rxb=0 txb=0
dpd: mode=active on=1 idle=5000ms retry=3 count=0 seqno=1455
natt: mode=none draft=0 interval=0 remote_port=0
proxyid=to_FGT2 proto=0 sa=0 ref=1 auto_negotiate=0 serial=5

src: 10.1.1.0/255.255.255.0:0
dst: 10.2.2.0/255.255.255.0:0

The above tunnel is down (output given as example)!

FGT2 # diagnose vpn tunnel list

list all ipsec tunnel in vd 0
------------------------------------------------------
name=to_FGT1 10.2.2.100:0->10.1.1.100:0 lgwy=dyn tun=tunnel mode=auto bound_if=0
proxyid_num=1 child_num=0 refcnt=7 ilast=1 olast=1
stat: rxp=0 txp=0 rxb=0 txb=0
dpd: mode=active on=1 idle=5000ms retry=3 count=0 seqno=21 natt:
mode=none draft=0 interval=0 remote_port=0
proxyid=to_FGT1 proto=0 sa=1 ref=2 auto_negotiate=0 serial=1

src: 10.2.2.0/255.255.255.0:0
dst: 10.1.1.0/255.255.255.0:0
SA: ref=3 options=00000009 type=00 soft=0 mtu=1436 expire=1771 replaywin=0 seq no=1
life: type=01 bytes=0/0 timeout=1773/1800
dec: spi=c1a8e951 esp=3des key=24 9213fdf22b150e01abb3535d1a647044eebf772b92f2f7ee
ah=sha1 key=20 66a38bf99f0b2d234f64b5a05187995c4f56f6bb
enc: spi=322067b4 esp=3des key=24 720e5680329937fb3630b7ed70bd41bb3114d3c269ae8b61
ah=sha1 key=20 e316113eb6ea03b014b3a5f9c1a3bd386637801a
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The above tunnel is up!

Verify that destination local hosts are seen in the ARP table (necessary for IPsec despite being in TP
mode)

FGT2 # get system arp

Address Age(min) Hardware Addr Interface
10.2.2.10 2 00:50:56:00:76:04 root.b
10.2.2.254 0 00:09:0f:30:29:e4 root.b

Using the debug flow command on the initiator side (example on FortiGate1)

FGT1 # diagnose debug flow filter addr 10.1.1.10
FGT1 # diagnose debug flow show console enable
FGT1 # diagnose debug enable
FGT1 # diagnose debug flow trace start 50

FGT1 # id=36870 trace_id=615 msg="vd-root received a packet(proto=1, 10.1.1.10:512-
>10.2.2.10:8) from port1."
id=36870 trace_id=615 msg="allocate a new session-00000636"
id=36870 trace_id=615 msg="Allowed by Policy-1: encrypt"
id=36870 trace_id=615 msg="enter IPsec tunnel-to_FGT2"
id=36870 trace_id=615 msg="SA is not ready yet, drop"
id=36870 trace_id=616 msg="vd-root received a packet(proto=1, 10.1.1.10:512->10.2.2.10:8)

from port1."
id=36870 trace_id=616 msg="Find an existing session, id-00000636, original direction"
id=36870 trace_id=616 msg="enter IPsec tunnel-to_FGT2"
id=36870 trace_id=616 msg="encrypted, and send to 10.2.2.100 with source 10.1.1.100"
id=36870 trace_id=616 msg="send out via dev-port2, dst-mac-00:09:0f:30:29:e0"
id=36870 trace_id=617 msg="vd-root received a packet(proto=1, 10.1.1.10:512->10.2.2.10:8)

from port1."
id=36870 trace_id=617 msg="Find an existing session, id-00000636, original direction"
id=36870 trace_id=617 msg="enter IPsec tunnel-to_FGT2"
id=36870 trace_id=617 msg="encrypted, and send to 10.2.2.100 with source 10.1.1.100"
id=36870 trace_id=617 msg="send out via dev-port2, dst-mac-00:09:0f:30:29:e0"
id=36870 trace_id=618 msg="vd-root received a packet(proto=1, 10.2.2.10:512->10.1.1.10:0)

from port2."
id=36870 trace_id=618 msg="Find an existing session, id-00000636, reply direction"
id=36870 trace_id=618 msg="send out via dev-port1, dst-mac-00:50:56:00:76:03"
id=36870 trace_id=619 msg="vd-root received a packet(proto=1, 10.1.1.10:512->10.2.2.10:8)

from port1."
id=36870 trace_id=619 msg="Find an existing session, id-00000636, original direction"
id=36870 trace_id=619 msg="enter IPsec tunnel-to_FGT2"
id=36870 trace_id=619 msg="encrypted, and send to 10.2.2.100 with source 10.1.1.100"
id=36870 trace_id=619 msg="send out via dev-port2, dst-mac-00:09:0f:30:29:e0"
id=36870 trace_id=620 msg="vd-root received a packet(proto=1, 10.2.2.10:512->10.1.1.10:0)

from port2."
id=36870 trace_id=620 msg="Find an existing session, id-00000636, reply direction"
id=36870 trace_id=620 msg="send out via dev-port1, dst-mac-00:50:56:00:76:03"

The message "id=36870 trace_id=615 msg="SA is not ready yet,
drop" simply means that the tunnel was not up yet.
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Using the debug flow command on the receiver side (example on FortiGate2)

FGT2 # diagnose debug flow filter addr 10.1.1.10
FGT2 # diagnose debug flow show console enable
FGT2 # diagnose debug enable
FGT2 # diagnose debug flow trace start 50

FGT2 # id=36870 trace_id=51 msg="vd-root received a packet(proto=1, 10.1.1.10:512-
>10.2.2.10:8) from port2."

id=36870 trace_id=51 msg="allocate a new session-00000435"
id=36870 trace_id=51 msg="Allowed by Policy-1:"
id=36870 trace_id=51 msg="send out via dev-port1, dst-mac-00:50:56:00:76:04"
id=36870 trace_id=52 msg="vd-root received a packet(proto=1, 10.2.2.10:512->10.1.1.10:0)

from port1."
id=36870 trace_id=52 msg="Find an existing session, id-00000435, reply direction"
id=36870 trace_id=52 msg="enter IPsec tunnel-to_FGT1"
id=36870 trace_id=52 msg="encrypted, and send to 10.1.1.100 with source 10.2.2.100"
id=36870 trace_id=52 msg="send out via dev-port2, dst-mac-00:09:0f:30:29:e4"

Using the sniffer trace (example on FortiGate2)

FGT2 # diagnose sniffer packet any "host 10.2.2.10" 4

9.460021 root.b out arp who-has 10.2.2.10 tell 10.2.2.100
9.460028 port2 out arp who-has 10.2.2.10 tell 10.2.2.100
9.460034 port1 out arp who-has 10.2.2.10 tell 10.2.2.100
9.460462 port1 in arp reply 10.2.2.10 is-at 0:50:56:0:76:4
9.460462 root.b in arp reply 10.2.2.10 is-at 0:50:56:0:76:4
[...]
49.477368 port2 in 10.1.1.10 -> 10.2.2.10: icmp: echo request
49.477444 port1 out 10.1.1.10 -> 10.2.2.10: icmp: echo request
49.477898 port1 in 10.2.2.10 -> 10.1.1.10: icmp: echo reply
50.510023 port2 in 10.1.1.10 -> 10.2.2.10: icmp: echo request
50.510079 port1 out 10.1.1.10 -> 10.2.2.10: icmp: echo request
50.510524 port1 in 10.2.2.10 -> 10.1.1.10: icmp: echo reply

The above ARP process in Transparent mode with IPsec is allowing the Fortigate to:
l Identify the MAC address of the destination device 10.2.2.10
l Populate the MAC table (see below), which in turn will give a destination interface
and allow a Firewall policy look-up

Check the FDB entries for the destination

FGT2 # diagnose netlink brctl name host root.b

port no device devname mac addr ttl
[..]
1 2 port1 00:50:56:00:76:04 0
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Example 2: Remote Sites on the Same Subnet

This example provides a configuration example for IPsec VPN tunnels between two FortiGate in Transparent
Mode in the same subnet separated by a L2 transparent network and one remote subnet on the second site.

This scenario requires that PC1’s MAC address is added to the FortiGate’s static MAC
table. The preferred scenario would be to have a router installed between the 2
FortiGate’s.

The expectation for this example is that PC1 will be able to communicate via the IPsec tunnel with Server1 in the
same subnet, and Server2 in a different subnet.

The requirements for this example are:

l The default gateway (FGT3) for PC1 and all remote device must be behind port2 of FGT1, in order for this
FortiGate to match the appropriate Encrypt firewall policy (port1 --> port2)

l Despite being in Transparent mode, FGT2 must have a valid route to Server2
l FGT3 is used as a router between subnet 10.1.1.0/24 and 10.3.3.0/24.

PC1 MAC address added to FGT2 static MAC entries.

Server1 MAC address added to FGT1 static MAC entries.

Configuration of FortiGate 1 (FGT1):

Only relevant parts of configuration are provided.

config system settings
set opmode transparent
set manageip 10.1.1.100/255.255.255.0

end

config router static
edit 1

set gateway 10.1.1.252
next

end
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config system mac-address-table
edit 00:50:56:00:76:04 ==>Server1

set interface port2
next

end

config firewall address
edit "all"
next
edit "Server1"

set subnet 10.1.1.20 255.255.255.255
next
edit "Server2"

set subnet 10.3.3.30 255.255.255.255
next
edit "10.1.1.0/24"

set subnet 10.1.1.0 255.255.255.0
next
edit "gateway"

set subnet 10.1.1.254 255.255.255.255
next

end

config vpn ipsec phase1
edit "to_FGT2"

set proposal 3des-sha1 aes128-sha1 des-md5
set remote-gw 10.1.1.200
set psksecret fortinet

next
end

config vpn ipsec phase2
edit "to_FGT2"

set keepalive enable
set phase1name "to_FGT2"
set proposal 3des-sha1 aes128-sha1
set src-subnet 10.1.1.0 255.255.255.0

next
end

config firewall policy
edit 1

set srcintf "port1"
set dstintf "port2"
set srcaddr "10.1.1.0/24"
set dstaddr "Server1"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "to_FGT2"

next
edit 2

set srcintf "port1"
set dstintf "port2"
set srcaddr "10.1.1.0/24"
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set dstaddr "Server2"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "to_FGT2"

next
edit 3

set srcintf "port1"
set dstintf "port2"
set srcaddr "10.1.1.0/24"
set dstaddr "gateway"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "to_FGT2"

next
end

Firewall Policy 3 is not mandatory and is only used to allow PC1 to test a ping
reachability to its default gateway 10.1.1.254.

Configuration of FortiGate 2 (FGT2):

Only relevant parts of configuration are provided.

config system settings
set opmode transparent
set manageip 10.1.1.200/255.255.255.0

end

config router static
edit 1

set gateway 10.1.1.252
next
edit 2

set dst 10.3.3.0 255.255.255.0
set gateway 10.1.1.254

next
end

config system mac-address-table
edit 00:50:56:00:76:03

set interface wan1
next

end

config firewall address
edit "all"
next
edit "PC1"
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set subnet 10.1.1.10 255.255.255.255
next
edit "10.1.1.0/24"

set subnet 10.1.1.0 255.255.255.0
next
edit "10.3.3.0/24"

set subnet 10.3.3.0 255.255.255.0
next

end

config vpn ipsec phase1
edit "to_FGT1"

set proposal 3des-sha1 aes128-sha1 des-md5
set remote-gw 10.1.1.100
set psksecret fortinet

next
end

config vpn ipsec phase2
edit "to_FGT1"

set keepalive enable
set phase1name "to_FGT1"
set proposal 3des-sha1 aes128-sha1
set dst-subnet 10.1.1.0 255.255.255.0

next
end

config firewall policy
edit 1

set srcintf "internal"
set dstintf "wan1"
set srcaddr "10.1.1.0/24"
set dstaddr "PC1"
set action ipsec
set schedule "always"
set service "ALL"
set inbound enable
set outbound enable
set vpntunnel "to_FGT1"

next
edit 2

set srcintf "internal"
set dstintf "wan1"
set srcaddr "10.3.3.0/24" set dstaddr "PC1"
set action ipsec
set schedule "always"
set service "ALL" set inbound enable
set outbound enable
set vpntunnel "to_FGT1"

next
end

Troubleshooting procedure

Check the ARP entries of PC1

C:\ arp -a
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Interface: 10.1.1.10 --- 0x20003
Internet Address Physical Address Type
10.1.1.20 00-50-56-00-76-04 dynamic
10.1.1.254 00-09-0f-85-3f-c8 dynamic

MAC address 00-09-0f-85-3f-c8 is the FGT3 interface in subnet 10.1.1.0/24.

FDB entries of FGT1

FGT1 (global) # diagnose netlink brctl name host Vdom1.b

show bridge control interface Vdom1.b host. fdb:
size=256, used=6, num=6, depth=1
Bridge Vdom1.b host table
port no device devname mac addr ttl attributes
1 10 port1 00:50:56:00:76:03 0
2 9 port2 00:50:56:00:76:04 44 static
2 9 port2 00:09:0f:85:3f:c8 13
1 10 port1 00:09:0f:88:2f:69  0 Local Static
2 9 port2 00:09:0f:88:2f:68 0 Local Static
2 9 port2 00:09:0f:23:01:d6 0

MAC address 00:09:0f:23:01:d6 is “internal” port MAC address of FGT2
00:09:0F:23:01:D6. This is the MAC address used for management in the
Transparent mode VDOM of FGT2, chosen between the lowest MAC address
between wan1 (00:09:0F:78:00:74) and internal (00:09:0F:23:01:D6).

ARP entries of FGT2

FGT2 (TP) # get system arp

Address Age(min) Hardware Addr Interface
10.1.1.20 82 00:50:56:00:76:04 TP.b
10.1.1.100 13 00:09:0f:88:2f:68 TP.b
10.1.1.254 76 00:09:0f:85:3f:c8    TP.b

it is important to have the entry for 10.1.1.254 which is the route to 10.3.3.0/24 .

IPsec Tunnel verification on FGT1

FGT1 (Vdom1) # diagnose vpn tunnel list

list all ipsec tunnel in vd 3
------------------------------------------------------
name=to_FGT2 10.1.1.100:0->10.1.1.200:0 lgwy=dyn tun=tunnel mode=auto bound_if=0
proxyid_num=1 child_num=0 refcnt=10 ilast=0 olast=0
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stat: rxp=2754 txp=2945 rxb=308448 txb=176700
dpd: mode=active on=1 idle=5000ms retry=3 count=0 seqno=166 natt:
mode=none draft=0 interval=0 remote_port=0
proxyid=to_FGT2 proto=0 sa=1 ref=2 auto_negotiate=0 serial=1

src: 10.1.1.0/255.255.255.0:0
dst: 0.0.0.0/0.0.0.0:0
SA: ref=3 options=00000009 type=00 soft=0 mtu=1436 expire=1271 replaywin=0 seqno=1e1

life:type=01 bytes=0/0 timeout=1750/1800
dec: spi=3f148cb7 esp=3des key=24 834832201a0dbbf60b0098106f08380538dbd94cacd1ad31

ah=sha1 key=20 b0257a135cba745b956bef3d4b8a6e65934c074b
enc: spi=1895305e esp=3des key=24 4d3092f0b3f84184d4779f85a9953230bf9bc28bd93c0afa

ah=sha1 key=20 0c70acf6ad2193ec5934e2a4332fd09f32016e60
npu_flag=00 npu_rgwy=10.1.1.200 npu_lgwy=10.1.1.100 npu_selid=0

Sniffer trace on FGT1 when PC1 pings all 3 remote destinations

FGT1 (Vdom1) # diagnose sniffer packet any "icmp" 4

interfaces=[any]
filters=[icmp]
0.342268 port1 in 10.1.1.10 -> 10.3.3.30: icmp: echo request
0.342844 port2 in 10.3.3.30 -> 10.1.1.10: icmp: echo reply
0.342884 port1 out 10.3.3.30 -> 10.1.1.10: icmp: echo reply
0.771700 port1 in 10.1.1.10 -> 10.1.1.20: icmp: echo request
0.772504 port2 in 10.1.1.20 -> 10.1.1.10: icmp: echo reply
0.772539 port1 out 10.1.1.20 -> 10.1.1.10: icmp: echo reply
0.907377 port1 in 10.1.1.10 -> 10.1.1.254: icmp: echo request
0.907850 port2 in 10.1.1.254 -> 10.1.1.10: icmp: echo reply
0.907883 port1 out 10.1.1.254 -> 10.1.1.10: icmp: echo reply

Sniffer trace on FGT1 filtered on IPsec protocol

FGT1 (Vdom1) # diagnose sniffer packet port2 "proto 50" 6

interfaces=[port2]
filters=[proto 50]
pcap_lookupnet: port2: no IPv4 address assigned

1.249003 port2 -- 10.1.1.100 -> 10.1.1.200: ip-proto-50 92
0x0000 0009 0f23 01d6 0009 0f88 2f68 0800 4500 ...# ..... /h..E.
0x0010 0070 c9e6 0000 3f32 9a48 0a01 0164 0a01 .p ... ?2.H...d..
0x0020 01c8 1895 305f 0000 01e2 02b6 37b6 8b2c ....0_ ..... 7..,

1.249478 port2 -- 10.1.1.200 -> 10.1.1.100: ip-proto-50 92
0x0000 0009 0f88 2f68 0009 0f23 01d6 0800 4500 ..../h...# ... E.
0x0010 0070 2e31 0000 3f32 35fe 0a01 01c8 0a01 .p.1..?25 ......
0x0020 0164 3f14 8cb8 0000 01e2 324d 66e2 9236 .d? ...... 2Mf..6

From the above trace, the MAC address 0009 0f88 2f68 is the MAC address of FGT1
port2 . This is the MAC address used for management in the Transparent mode
VDOM of FGT1, chosen between the lowest MAC address between port1
(00:09:0F:88:2F:69) and port2 ( (00:09:0F:88:2F:68).
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Debug flow on FGT1 filtered on Server3

FGT1 (Vdom1) # diagnose debug flow filter addr 10.3.3.30
FGT1 (Vdom1) # diagnose debug flow show console enable
FGT1 (Vdom1) # diagnose debug enable
FGT1 (Vdom1) # diagnose debug flow trace start 10

id=20085 trace_id=11 msg="vd-Vdom1 received a packet(proto=1, 10.1.1.10:512->10.3.3.30:8)
from port1."

id=20085 trace_id=11 msg="Find an existing session, id-00004e85, original direction"
id=20085 trace_id=11 msg="enter IPsec tunnel-to_FGT2"
id=20085 trace_id=11 msg="encrypted, and send to 10.1.1.200 with source 10.1.1.100"
id=20085 trace_id=11 msg="send out via dev-port2, dst-mac-00:09:0f:23:01:d6"
id=20085 trace_id=12 msg="vd-Vdom1 received a packet(proto=1, 10.3.3.30:512->10.1.1.10:0)

from port2."
id=20085 trace_id=12 msg="Find an existing session, id-00004e85, reply direction"
id=20085 trace_id=12 msg="send out via dev-port1, dst-mac-00:50:56:00:76:03"

From the trace above, dst-mac-00:09:0f:23:01:d6 is “internal” port MAC address of
FGT2 00:09:0F:23:01:D6. This is the MAC address used for management in the
Transparent mode VDOM of FGT2, chosen between the lowest MAC address
between wan1 (00:09:0F:78:00:74) and internal (00:09:0F:23:01:D6).
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Using FortiManager and FortiAnalyzer

FortiManager and FortiAnalyzer are supported similarly to NAT mode.

Establishing a communication to a FortiAnalyzer is done as per the example hereafter (from global level if VDOM
is enabled). This setting is independent from being in Transparent mode. However, as stated earlier in this
section the management VDOM must have IP connectivity to the FortiAnalyzer.

FGT (global) # show system fortianalyzer

config system fortianalyzer
set status enable
set server 10.2.2.2

end
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This section contains information about configuring high availability in Transparent mode. It contains the
following topics:

l Virtual Clustering
l MAC Address Assignment

Any other statement and feature description in this document apply to a FortiGate Cluster running in Active-
Passive mode.

Virtual Clustering
If VDOM (virtual domain) is enabled on a cluster operating Transparent Mode, HA Virtual Clustering can be
configured in active-passive mode.

This will provide:

l Failover protection between two instances of a VDOM operating on two different FortiGate in the cluster.
l Load balancing between the FortiGate units on a per-VDOM basis.

The roles have been defined such as, in normal operation:

l FortiGate1 is Master for Vdom1 and Slave for Vdom2
l FortiGate2 is Master for Vdom2 and Slave for Vdom1

In case of a failure or reboot of a FortiGate, the remaining unit will become Master for Vdom1 and Vdom2.

The VDOMs given in this example are showing physical ports but a VDOM can also
include VLAN interfaces.

The L2 connectivity between the FortiGate is showing 4 separate L2 switches, but it
could also be one single switch one each side configured with appropriate VLANs.

Configuration example

l FortiGate1:

FGT1 (global) # show system ha

config system ha
set mode a-p
set hbdev "port5" 0 "port6" 0
set vcluster2 enable
set override disable
set priority 200

config secondary-vcluster
set override enable
set priority 100
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set vdom "Vdom2"
end

end

l FortiGate2:

FGT2 (global) # show system ha

config system ha
set mode a-p
set hbdev "port5" 0 "port6" 0
set vcluster2 enable
set override disable
set priority 200

config secondary-vcluster
set override enable
set priority 100
set vdom "Vdom2"

end
end

MAC Address Assignment
If a cluster is operating in Transparent mode, the FortiGate Clustering Protocol (FGCP) assigns a virtual MAC
address for the Master unit management IP address. Since you can connect to the management IP address from
any interface, all of the FortiGate interfaces appear to have the same virtual MAC address.
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Best Practices

1. Create forwarding domains when VLANs are used and set vlanforward to disable on all relevant physical
interface.

2. The forward-domain ID can be different to the VLAN ID, but it is recommended for troubleshooting and readability
to keep them the same.

3. Only interfaces from the same forwarding domains can have firewall policies between each others.

4. In order to allow IVL (independent VLAN learning), the VLANsmust be placed in separate forwarding domains.

5. If an out-of-band management is desired, use if possible a VDOM in NAT mode as management VDOM and
create (an) other Transparent mode VDOM(s) for the user traffic.

6. As Spanning Tree BPDUs are not forwarded by default, insert the FortiGate with caution to avoid L2 loops.

7. Multicast packets are not forwarded by default; this might cause routing protocols (RIP2,OSPF) disruption.

8. When using HSRP or VRRP configure static MAC entries for the Virtual MAC addresses.
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Chapter 31 - Troubleshooting

Troubleshooting

Welcome and thank you for selecting Fortinet products to protect your organization's network.

This guide is intended for administrators who need guidance on different network needs and information on basic
and advanced troubleshooting.

This chapter contains the following topics:

l Before you begin
l How this guide is organized

Before you begin
Before you begin using this guide, verify the following:

l You have administrative access to the FortiGate GUI and/or CLI.
l The FortiGate is integrated into your network.
l The operation mode is configured.
l The system time, DNS settings, administrator password, and network interfaces are configured.
l Firmware, FortiGuard AntiVirus, FortiGuard Application Control, and FortiGuard IPS are up to date.

To complete the tasks in this guide, you must have super_admin administrative access (unless otherwise
specified). Users with other types of administrative access may not be able to complete the troubleshooting
tasks.

How this guide is organized
This handbook chapter presents troubleshooting and problem solving issues that may help you with your
FortiGate and contains the following sections:

l "Troubleshooting methodologies" on page 3262 walks you through best practice concepts of FortiOS
troubleshooting.

l "Troubleshooting tools" on page 3266 describes some of the basic commands and parts of FortiOS that can help
you with troubleshooting.

l "Troubleshooting tips" on page 3292 presents most of the common issues and how to address them.
l "Troubleshooting resources" on page 3316 identifies Fortinet resources for troubleshooting.

Troubleshooting methodologies

This section explains how to prepare for troubleshooting, create a troubleshooting plan, and where to find
additional resources.

The following topics are covered:
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l Ensure you have administrator-level access to required equipment
l Establish a baseline
l Define the problem
l Create a troubleshooting plan
l Obtain any required equipment
l Consult Fortinet resources

Ensure you have administrator-level access to required equipment
Before troubleshooting your FortiGate, you need administrator access to the equipment. If you're a client on a
FortiGate that has virtual domains (VDOMs) enabled, you can often troubleshoot within your own VDOM.
However, you should inform the super admin for the FortiGate that you'll be performing troubleshooting tasks.

Also, you may need access to other networking equipment, such as switches, routers, and servers, to carry out
tests. If you don't have access to this equipment, contact your network administrator for assistance.

Establish a baseline
A FortiGate operates at all layers of the OSI model. For this reason, troubleshooting problems can become
complex. Establishing baseline parameters for your system before a problem occurs helps to reduce the
complexity when you need to troubleshoot.

Many of the guiding questions in the following sections compare the current problem to normal operation on your
FortiGate. A best practice is to establish and record the normal operating status. Regular operation data shows
trends, and allows you to see when changes occur and when there may be a problem. You can gather this data by
using logs and SNMP tools to monitor the system performance or by regularly running information gathering
commands and saving the output.

Back up your FortiOS configuration on a regular basis. This is a good practice and not
only for troubleshooting. You can restore the backed up configuration as needed and
save the time and effort of recreating it from the factory default settings.

You can use the following CLI commands to obtain normal operating data for a FortiGate:

get system status Displays firmware versions and FortiGuard engine versions, and
other system information

get system performance status
Displays CPU and memory states, average network usage,
average sessions and session setup rate, virus caught, IPS
attacks blocked, and uptime

get hardware memory Displays information about memory

get system session status Displays total number of sessions

get router info routing-table
all

Displays all the routes in the routing table, including their type,
source, and other useful data
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get ips session Displays memory used and maximum amount available to IPS
as well and counts

get webfilter ftgd-statistics Displays a list of FortiGuard related counts of status, errors, and
other data

diagnose sys session list Displays the list of current detailed sessions

show system dns Displays the configured DNS servers

diagnose sys ntp status Displays information about NTP servers

These commands are just a sample. You can run any commands for information gathering that apply to your
system. For example, if you have active VPN connections, use the get vpn * series of commands to get more
information about them.

To see an extensive snapshot of your system, you can use the execute tac report command. This
command runs many diagnostic commands for specific configurations. Regardless of the features deployed on
your FortiGate, this command records the current state of each feature. Then, if you need to perform
troubleshooting later, you can run the same command again and compare the differences to quickly identify any
suspicious output.

Define the problem
The following questions help you define the problem. Be as specific as possible with your answers. Once you
define the problem, you can search for a solution and then create a plan for how to solve it.

l what's the problem?
The problem being observed isn't necessarily the actual problem. You should determine where the problem lies
before starting to troubleshoot the FortiGate.

l Was the device working before?
If the device never worked, it might be defective. For more information, see Troubleshooting your FortiGate
Installation in the Getting Started chapter.

l Can you reproduce the problem ?
If the problem is intermittent, it may be dependent on system load. Note that it may be difficult to troubleshoot an
intermittent problem because it's difficult to reproduce.

l What has changed?
Don't assume that nothing has changed in the network. Use the FortiGate event log to identify any possible
configuration changes. Changes can be in the operating environment. For example, there might be a gradual
increase in load as more sites are forwarded through the firewall.

If something has changed, roll back the change and assess the impact.

l What's the scope of the problem?
After you isolate the problem, determine what applications, users, devices, and operating systems are affected.
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l What's not working? Be specific.
l Is there more than one thing that isn't working?
l Is it partly working? If so, what parts are working?
l Is it a connectivity issue for the entire device, or is there an application that isn’t reaching the Internet?
l Where did the problem occur?
l When did the problem occur and to which users or groups of users?
l What components are involved?
l What applications are affected?
l Can you use a packet sniffer to trace the problem?
l Can you use system debugging or look in the session table to trace the problem?
l Do any of the log files indicate a failure has occurred?

The answers to these questions help you narrow down the problem and identify what you should check during
your troubleshooting. The more things you can eliminate, the fewer things you need to check during
troubleshooting. For this reason, be as specific and accurate as you can when you gather information.

Create a troubleshooting plan
Once you define the problem and gather facts, you can create a troubleshooting plan to solve the problem.

You should list all possible causes of the problem that you can think of and how you can test for each possible
cause. The plan acts as a checklist so that you know what you've tried and what's left to check. This is also
important to have if more than one person is performing troubleshooting tasks. Be ready to add to your plan, as
needed.

A troubleshooting plan is also useful when you contact Fortinet Support. It provides you with a record of
information about the problem and the tasks that you tried to fix it.

Providing supporting elements

If you contact Fortinet Support to speak to the Technology Assistance Center (TAC), be prepared to provide the
following information:

l Firmware build version (use the get system status command)
l Network topology diagram
l Recent configuration file
l Recent debug log (optional)
l Summary of troubleshooting steps that you've already taken and the results.

Don't provide the output from the execute tac report unless TAC requests it. The
output from this command is very large and isn't required in many cases.

Obtain any required equipment
To test your solution, you may require additional networking equipment, computers, or other equipment.
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Network administrators usually have additional networking equipment available to loan you, or a lab where you
can bring the FortiGate unit to test.

If you don't have access to equipment, check for shareware applications that can perform the same tasks. Often,
there are software solutions that you can use when hardware is too expensive.

Consult Fortinet resources
After you define your problem, create a plan to find a solution, and carry out that plan. If you can't resolve the
problem, see "Troubleshooting resources" on page 3316.

Troubleshooting tools

FortiOS provides a number of tools that help with troubleshooting both hardware and software issues. These
tools include diagnostics and ports; ports are used when you need to understand the traffic coming in and going
out on a specific port, for example, UDP 53, which is used by the FortiGate unit for DNS lookup and RBL lookup.

This section also contains information about troubleshooting FortiGuard issues.

l "FortiOS diagnostics" on page 3266
l "FortiOS ports" on page 3288
l "FortiAnalyzer and FortiManager ports" on page 3289
l "FortiGuard troubleshooting" on page 3289

FortiOS diagnostics
FortiOS has a collection of diagnostic commands that you can use to troubleshoot and monitor the performance
of your network. The get and diagnose CLI commands are the two main groups of diagnostic commands.
Both commands display information about system resources, connections, and settings that allow you to locate
problems or monitor system performance.

This topic includes diagnostics commands to help with:

l Date and time
l Resource usage
l Proxy operation
l Hardware NIC
l Traffic trace
l Session table
l Firewall session setup rate
l Finding object dependencies
l Flow trace
l Packet sniffing and packet capture
l NPU-based interfaces
l Debug command
l The execute tac report command
l Other commands
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Date and time

The system date and time are important for FortiGuard services, logging events, and sending alerts. The wrong
time makes the log entries confusing and difficult to use.

Use Network Time Protocol (NTP) to set the date and time, if possible. This is an automatic method that doesn't
require manual intervention. However, you must ensure that the port is allowed through the firewalls on your
network. FortiToken synchronization requires NTP in many situations.

How to set the date and time - GUI

1. Go to the System Information widget on the Dashboard. The date and time are displayed next to System
Time.

2. To adjust the date and time settings, go to System > Settings.
3. In System Time, you can set the time zone, date and time, and select NTP usage.

How to check the date and time - CLI

You can check the date and time using the CLI commands execute date and execute time.

config system global
set timezone <integer>

end
config system ntp

set type custom
config ntpserver

edit 1
set server “ntp1.fortinet.net”

next
edit 2

set server “ntp2.fortinet.net”
next

end
set ntpsync enable
set syncinterval 60
end

Use the set timezone ? command to display a list of timezones and the integers that represent them.

Resource usage

Each program that runs on a computer has one or more processes associated with it. For example, if you open a
Telnet program, it has an associated Telnet process. The same is true in FortiOS. All processes share system
resources in FortiOS, including memory and CPU.

Use the get system performance status command to show the FortiOS performance status.

Sample output:

FGT# get system performance status
CPU states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU0 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU1 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU2 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU3 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
Memory: 4050332k total, 527148k used (13%), 3381312k free (83%), 141872k freeable (3%)
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Average network usage: 41 / 28 kbps in 1 minute, 54 / 44 kbps in 10 minutes, 42 / 34
kbps in 30 minutes

Average sessions: 33 sessions in 1 minute, 48 sessions in 10 minutes, 38 sessions in 30
minutes

Average session setup rate: 0 sessions per second in last 1 minute, 0 sessions per
second in last 10 minutes, 0 sessions per second in last 30 minutes

Virus caught: 0 total in 1 minute
IPS attacks blocked: 0 total in 1 minute
Uptime: 0 days, 22 hours, 59 minutes

Monitor the CPU and memory usage of internal processes, using the following command:

get system performance top <delay> <max_lines>

The data that the command lists includes the name of the daemon, the process ID, whether the process is
sleeping or running, the CPU use percentage, and the memory use percentage.

Sample output:

get system performance top 10 100
Run Time: 0 days, 23 hours and 4 minutes
0U, 0N, 0S, 100I, 0WA, 0HI, 0SI, 0ST; 3955T, 3298F

httpsd 212 S 0.4 0.6
forticron 169 S 0.4 0.4
newcli 4054 R 0.4 0.2
reportd 174 S 0.0 1.4
pyfcgid 325 S 0.0 0.8
cmdbsvr 141 S 0.0 0.7
miglogd 160 S 0.0 0.6
httpsd 211 S 0.0 0.6
src-vis 180 S 0.0 0.6
pyfcgid 327 S 0.0 0.6
pyfcgid 328 S 0.0 0.6
pyfcgid 329 S 0.0 0.6
httpsd 162 S 0.0 0.5
cw_acd 189 S 0.0 0.5
httpsd 3998 S 0.0 0.5
httpsd 4050 S 0.0 0.5
updated 176 S 0.0 0.5
httpsd 4052 S 0.0 0.4
miglogd 203 S 0.0 0.4
miglogd 204 S 0.0 0.4

Proxy operation

Monitor proxy operations, using the following command:

diagnose test application <application> <option>

To display a list of available <application> values, enter:

diagnose test application ?

The <option> value depends on the application value that you use in the command. To display a list of
available <option> values, enter:

diagnose test application <application> ?
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For example, if the application is http, the CLI command that displays the <option> values is:

diagnose test application http ?

Hardware NIC

Monitor hardware network operations, using the following command:

diagnose hardware deviceinfo nic <interface>

The information that this command shows is important because errors at the interface indicate data link or
physical layer issues which may impact the performance of the FortiGate.

The following example shows a sample output when you set <interface> to lan:

System_Device_Name lan
Current_HWaddr 00:09:0f:68:35:60
Permanent_HWaddr 00:09:0f:68:35:60
State up
Link up
Speed 100
Duplex full
[……]
Rx_Packets=5685708
Tx_Packets=4107073
Rx_Bytes=617908014
Tx_Bytes=1269751248
Rx_Errors=0
Tx_Errors=0
Rx_Dropped=0
Tx_Dropped=0
[…..]

The diagnose hardware deviceinfo nic command displays a list of error names and values that are
related to hardware. The following table describes possible hardware errors:

Field Description

Rx_Errors = rx error count Bad frame was marked as error by PHY

Rx_CRC_Errors +
Rx_Length_Errors -
Rx_Align_Errors

This error is only valid in 10/100M mode

Rx_Dropped or
Rx_No_Buffer_Count

Running out of buffer space

Rx_Missed_Errors Equals Rx_FIFO_Errors + CEXTERR (Carrier Extension Error Count); only
valid in 1000M mode, which is marked by PHY

Tx_Errors = Tx_Aborted_
Errors

ECOL (Excessive Collisions Count); only valid in half-duplex mode
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Field Description

Tx_Window_Errors

Late Collisions (LATECOL) Count

Late collisions are collisions that occur after 64-byte time into the
transmission of the packet while working in 10 to 100 Mb/s data rate and
512-byte time into the transmission of the packet while working in the
1,000 Mb/s data rate. This register only increments if transmits are enabled
and the device is in half-duplex mode.

Rx_Dropped See Rx_Errors

Tx_Dropped Not defined

Collisions Total number of collisions experienced by the transmitter; valid in half-
duplex mode

Rx_Length_Errors Transmission length error

Rx_Over_Errors Not defined

Rx_CRC_Errors Frame CRC error

Rx_Frame_Errors Same as Rx_Align_Errors

This error is only valid in 10/100M mode.

Rx_FIFO_Errors Same as Rx_Missed_Errors - a missed packet count

Tx_Aborted_Errors See Tx_Errors

Tx_Carrier_Errors

The PHY should assert the internal carrier sense signal during every
transmission. Failure to do so may indicate that the link has failed or the
PHY has an incorrect link configuration. This register only increments if
transmits are enabled. This register isn't valid in internal SerDes 1 mode
(TBI mode for the 82544GC/EI) and is valid only when the Ethernet
controller is operating at full duplex.

Tx_FIFO_Errors Not defined

Tx_Heartbeat_Errors Not defined

Tx_Window_Errors See LATECOL

Tx_Single_Collision_Frames

Counts the number of times that a successfully transmitted packet
encountered a single collision

The value increments only if transmits are enabled and the Ethernet
controller is in half-duplex mode.
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Field Description

Tx_Multiple_Collision_Frames AMultiple Collision Count which indicates the number of times that a
transmit encountered more than one collision, but less than 16. The value
increments only if transmits are enabled and the Ethernet controller is in
half-duplex mode.

Tx_Deferred

Counts defer events

A deferred event occurs when the transmitter can't immediately send a
packet due to the medium being busy because another device is
transmitting, the IPG timer hasn't expired, half-duplex deferral events are
occurring, XOFF frames are being received, or the link isn't up. This
register only increments if transmits are enabled. This counter doesn't
increment for streaming transmits that are deferred due to TX IPG.

Rx_Frame_Too_Longs The Rx frame is oversized

Rx_Frame_Too_Shorts The Rx frame is too short

Rx_Align_Errors This error is only valid in 10/100M mode

Symbol Error Count

Counts the number of symbol errors between reads - SYMERRS.

The count increases for every bad symbol that's received, whether or not a
packet is currently being received and whether or not the link is up. This
register increments only in internal SerDes mode.

Traffic trace

Traffic tracing allows you to follow a specific packet stream. This is useful to confirm that packets are taking the
route you expect them to take on your network.

View the characteristics of a traffic session though specific security policies using:

diagnose sys session

Trace per-packet operations for flow tracing using:

diagnose debug flow

Trace per-Ethernet frame using:

diagnose sniffer packet

Trace a route from a FortiGate to a destination IP address

# execute traceroute www.fortinet.com
traceroute to www.fortinet.com (66.171.121.34), 32 hops max, 84 byte packets
1 172.20.120.2 0.637 ms 0.653 ms 0.279 ms
2 209.87.254.221 <static-209-87-254-221.storm.ca> 2.448 ms 2.519 ms 2.458 ms
3 209.87.239.129 <core-2-g0-2.storm.ca> 2.917 ms 2.828 ms 9.324 ms
4 209.87.239.199 <core-3-bdi1739.storm.ca> 13.248 ms 12.401 ms 13.009 ms
5 216.66.41.113 <v502.core1.tor1.he.net> 17.181 ms 12.422 ms 12.268 ms
6 184.105.80.9 <100ge1-2.core1.nyc4.he.net> 21.355 ms 21.518 ms 21.597 ms
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7 198.32.118.41 <ny-paix-gni.twgate.net> 83.297 ms 84.416 ms 83.782 ms
8 203.160.228.217 <217-228-160-203.TWGATE-IP.twgate.net> 82.579 ms 82.187 ms 82.066 ms
9 203.160.228.229 <229-228-160-203.TWGATE-IP.twgate.net> 82.055 ms 82.455 ms 81.808 ms
10 203.78.181.2 82.262 ms 81.572 ms 82.015 ms
11 203.78.186.70 83.283 ms 83.243 ms 83.293 ms
12 66.171.127.177 84.030 ms 84.229 ms 83.550 ms
13 66.171.121.34 <www.fortinet.com> 84.023 ms 83.903 ms 84.032 ms
14 66.171.121.34 <www.fortinet.com> 83.874 ms 84.084 ms 83.810 ms

Session table

A session is a communication channel between two devices or applications across the network. Sessions allow
FortiOS to inspect and act on a sequential group of packets in a session all together instead of inspecting each
packet individually. Each of these sessions has an entry in the session table that includes important information
about the session.

Use as a tool

Session tables are useful troubleshooting tools because they allow you to verify open connections. For example,
if you have a web browser open to browse the Fortinet website, you would expect a session entry from your
computer, on port 80, to the IP address for the Fortinet website. Another troubleshooting method is if there are
too many sessions for FortiOS to process, you can examine the session table for evidence why this is happening.

You can view the FortiGate session table from using the FortiGate GUI or the CLI. The most useful
troubleshooting data comes from the CLI. The session table in the GUI also provides useful summary
information, particularly the current policy number that the session is using.

GUI session information

You can view session information by going to the FortiView page. Read more about FortiView consoles in the
Handbook's FortiView chapter.

How to find which security policy a specific connection is using

Every program and device on your network must have a communication channel, or session, open to pass
information. The FortiGate manages these sessions with features such as traffic shaping, antivirus scanning, and
blocking known bad web sites. Each session has an entry in the session table.

You may want to find information for a specific session for troubleshooting. For example, if a secure web browser
session isn't working properly, you can check the session table to ensure the session is still active and going to the
proper address. The session table can also tell you the security policy number it matches, so you can check what's
happening in that policy.

1. Know your connection information.
You need to be able to identify the session you want. For this, you need the source IP address (usually
your computer), the destination IP address (if you have it) and the port number which is determined by
the program that you're using. Some commons ports are:

l Port 80 (HTTP for web browsing),
l Port 22 (SSH used for secure login and file transfers)
l Port 23 (Telnet for a text connection)
l Port 443 (HTTPS for secure web browsing)
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2. Find your session and policy ID.
Go to FortiView > All Sessions. Find your session by finding your source IP address, destination IP
address (if you have it), and port number. The policy ID is listed after the destination information. If
the list of sessions is very long, you can filter the list to make it easier to find your session.

3. When there are many sessions, use a filter to help you find your session.
If there are multiple pages of sessions, it's difficult to find a single session. You can use a filter to
block out sessions that you don’t want. Click the search icon on the column heading to select the filter.
Select Source IP and enter your source IP address. Now, only sessions that originate from your IP
address are displayed in the session table. If the list is still too long, you can do the same for the
Source port. That makes it easy to find your session and the security policy ID. When you're finished,
clear the filters.

CLI session information

The session table output that the diagnose sys session list command generates is very large. You can
use filters to display only the session data that you're interested in.

An entry is placed in the session table for each traffic session passing through a security policy. The following
command lists the information for a session in the table:

diagnose sys session list

The filter option displays specific information, for example:

diagnose sys session filter <option>

The values for <option> include the following:

clear Clear session filter

dintf Destination interface

dport Destination port

dst Destination IP address

duration Duration of the session

expire Expire

negate Inverse filter

nport NAT'd source port

nsrc NAT'd source IP address

policy Policy ID

proto Protocol number
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proto-state Protocol state

session-state1 Session state1

session-state2 Session state2

sintf Source interface

sport Source port

src Source IP address

vd Index of virtual domain, -1 matches all

Even though UDP is a sessionless protocol, the FortiGate keeps track of the following states:

l When UDP reply doesn't have a value of 0
l When UDP reply has a value of 1

The following table displays firewall session states from the session table:

State Description

log Session is being logged

local Session is originated from or destined for local stack

ext Session is created by a firewall session helper

may_dirty

Session is created by a policy

For example, the session for ftp control channel will have this state but ftp
data channel won't. This is also seen when NAT is enabled.

ndr Session will be checked by IPS signature

nds Session will be checked by IPS anomaly

br Session is being bridged (TP) mode

Firewall session setup rate

The number of sessions that can be established in a set period of time is useful information. A session is an end-
to-end TCP/IP connection for communication with a limited lifespan. If you record the setup rate during normal
operation, when you experience problems you can compare the baseline setup rate to the rate that occurs when
you're troubleshooting. This can be a useful step to help you define your problem.

A reduced firewall session setup rate can be the result of a number of things, such as a lack of system resources
on the FortiGate or reaching the limit of your session count for your VDOM.
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To view your session setup rate method 1 - CLI

FGT# get system performance status
CPU states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU0 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU1 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU2 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
CPU3 states: 0% user 0% system 0% nice 100% idle 0% iowait 0% irq 0% softirq
Memory: 4050332k total, 530512k used (13%), 3376844k free (83%), 142976k freeable (3%)
Average network usage: 131 / 90 kbps in 1 minute, 26 / 15 kbps in 10 minutes, 49 / 42

kbps in 30 minutes
Average sessions: 80 sessions in 1 minute, 30 sessions in 10 minutes, 42 sessions in 30

minutes
Average session setup rate: 3 sessions per second in last 1 minute, 0 sessions per

second in last 10 minutes, 0 sessions per second in last 30 minutes
Virus caught: 0 total in 1 minute
IPS attacks blocked: 0 total in 1 minute
Uptime: 1 days, 2 hours, 45 minutes

The information you're looking for is the average sessions section, in the above output. This example shows that
there were 80 sessions in 1 minute, or an average of 3 sessions per second. The values for 10 minutes and 30
minutes allow you to take a longer average for a more reliable value if your FortiGate is working at maximum
capacity. The smallest FortiGate can have 1,000 sessions established per second across the unit.

Remember that session setup rate is a global command. If you have multiple VDOMs configured with many
sessions in each one, the session setup rate per VDOM will be slower than if there are no VDOMs configured.

Finding object dependencies

An administrator may not be permitted to delete a configuration object if there are other configuration objects that
depend on it. This command identifies other objects which depend on, or make reference to, the configuration
object in question. If an error is displayed that an object is in use and can't be deleted, this command can help
identify the source of the problem.

Additionally, if you have a virtual interface with objects that depend on it, you need to find and remove those
dependencies before you delete the interface.

CLI method

When you run multiple VDOMs, you run this command in the global configuration only and it searches for the
named object in both the most recently used global and VDOM configurations:

diagnose sys checkused <path.object.mkey>

For example, to verify which objects a security policy with an ID of 1 refers to, enter the following command:

diagnose sys checkused firewall.policy.policyid 1

To check what's referred to by interface port1, enter the following command:

diagnose sys checkused system.interface.name port1

To show all dependencies for an interface, enter the following command:

diagnose sys checkused system.interface.name <interface name>

3275 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 31 - Troubleshooting Troubleshooting tools

Sample output:

entry used by table firewall.address:name '10.98.23.23_host’
entry used by table firewall.address:name 'NAS'
entry used by table firewall.address:name 'all'
entry used by table firewall.address:name 'fortinet.com'
entry used by table firewall.vip:name 'TORRENT_10.0.0.70:6883'
entry used by table firewall.policy:policyid '21'
entry used by table firewall.policy:policyid '14'
entry used by table firewall.policy:policyid '19'

In this example, the interface has dependent objects, including four address objects, one VIP, and three security
policies.

GUI method

In the GUI, you can easily check and remove the object dependencies for an interface.

To remove interface object dependencies - GUI

1. Go to Network > Interfaces.
The Ref. column displays the number of objects that refer to this interface.

2. Select the number in the Ref. column for the interface.
A window listing the dependencies appears.

3. Use these detailed entries to locate and remove object references to this interface.
The trash can icon changes from gray when you remove all object dependencies.

4. Remove the interface by selecting the check box for the interface, and select Delete.

Flow trace

To trace the flow of packets through the FortiGate, use the following command:

diagnose debug flow trace start

Follow packet flow by setting a flow filter, using this command:

diagnose debug flow {filter | filter6} <option>

If your network uses IPv4, enter filter. If your network uses IPv6, enter filter6.

One of the following variables replaces <option>:

Variable Description

addr IPv4 or IPv6 address

clear clear filter

daddr destination IPv4 or IPv6 address
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Variable Description

dport destination port

negate inverse IPv4 or IPv6 filter

port port

proto protocol number

saddr source address

sport source port

vd index of virtual domain; -1 matches all

diagnose debug flow output is recorded as event log messages which are then
sent to a FortiCloud or a FortiAnalyzer, if connected. Don't run this command longer
than necessary, since it generates significant amounts of data.

To start flow monitoring with a specific number of packets - CLI:

diagnose debug flow trace start <N>

To stop flow tracing at any time using - CLI:

diagnose debug flow trace stop

The following example shows the flow trace for a device with an IP address of 203.160.224.97:

diagnose debug enable
diagnose debug flow filter addr 203.160.224.97
diagnose debug flow show function-name enable
diagnose debug flow trace start 100

Flow trace output example - HTTP

To observe the debug flow trace, connect to the web site at the following address (the display may vary slightly):

https://www.fortinet.com

Comment: SYN packet received:

id=20085 trace_id=209 func=resolve_ip_tuple_fast
line=2700 msg="vd-root received a packet(proto=6,
192.168.3.221:1487->203.160.224.97:80) from port5."

SYN sent and a new session is allocated:

id=20085 trace_id=209 func=resolve_ip_tuple line=2799
msg="allocate a new session-00000e90"

Lookup for next-hop gateway address:
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id=20085 trace_id=209 func=vf_ip4_route_input line=1543
msg="find a route: gw-192.168.11.254 via port6"

Source NAT, lookup next available port:

id=20085 trace_id=209 func=get_new_addr line=1219
msg="find SNAT: IP-192.168.11.59, port-31925"
direction“

Matched security policy. Check to see which policy this session matches:

id=20085 trace_id=209 func=fw_forward_handler line=317
msg="Allowed by Policy-3: SNAT"

Apply source NAT:

id=20085 trace_id=209 func=__ip_session_run_tuple
line=1502 msg="SNAT 192.168.3.221->192.168.11.59:31925"

SYN ACK received:

id=20085 trace_id=210 func=resolve_ip_tuple_fast line=2700
msg="vd-root received a packet(proto=6, 203.160.224.97:80-
>192.168.11.59:31925) from port6."

Found existing session ID. Identified as the reply direction:

id=20085 trace_id=210 func=resolve_ip_tuple_fast line=2727
msg="Find an existing session, id-00000e90, reply direction"

Apply destination NAT to inverse source NAT action:

id=20085 trace_id=210 func=__ip_session_run_tuple
line=1516 msg="DNAT 192.168.11.59:31925-
>192.168.3.221:1487"

Lookup for next-hop gateway address for reply traffic:

id=20085 trace_id=210 func=vf_ip4_route_input line=1543
msg="find a route: gw-192.168.3.221 via port5"

ACK received:

id=20085 trace_id=211 func=resolve_ip_tuple_fast line=2700
msg="vd-root received a packet(proto=6,
192.168.3.221:1487->203.160.224.97:80) from port5."

Match existing session in the original direction:

id=20085 trace_id=211 func=resolve_ip_tuple_fast line=2727
msg="Find an existing session, id-00000e90, original
direction"

Apply source NAT:

id=20085 trace_id=211 func=__ip_session_run_tuple
line=1502 msg="SNAT 192.168.3.221->192.168.11.59:31925"

Receive data from client:
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id=20085 trace_id=212 func=resolve_ip_tuple_fast
line=2700 msg="vd-root received a packet(proto=6,
192.168.3.221:1487->203.160.224.97:80) from port5."

Match existing session in the original direction:

id=20085 trace_id=212 func=resolve_ip_tuple_fast
line=2727 msg="Find an existing session, id-00000e90,
original direction"

Apply source NAT:

id=20085 trace_id=212 func=__ip_session_run_tuple
line=1502 msg="SNAT 192.168.3.221->192.168.11.59:31925"

Receive data from server:

id=20085 trace_id=213 func=resolve_ip_tuple_fast
line=2700 msg="vd-root received a packet(proto=6,
203.160.224.97:80->192.168.11.59:31925) from port6."

Match existing session in reply direction:

id=20085 trace_id=213 func=resolve_ip_tuple_fast
line=2727 msg="Find an existing session, id-00000e90,
reply direction"

Apply destination NAT to inverse source NAT action:

id=20085 trace_id=213 func=__ip_session_run_tuple
line=1516 msg="DNAT 192.168.11.59:31925-
>192.168.3.221:1487"

Flow trace output example - IPsec (policy-based)

id=20085 trace_id=1 msg="vd-root received a packet(proto=1, 10.72.55.240:1->10.71.55.10:8)
from internal."

id=20085 trace_id=1 msg="allocate a new session-00001cd3"
id=20085 trace_id=1 msg="find a route: gw-66.236.56.230 via wan1"
id=20085 trace_id=1 msg="Allowed by Policy-2: encrypt"
id=20085 trace_id=1 msg="enter IPsec tunnel-RemotePhase1"
id=20085 trace_id=1 msg="encrypted, and send to 15.215.225.22 with source 66.236.56.226"
id=20085 trace_id=1 msg="send to 66.236.56.230 via intf-wan1“
id=20085 trace_id=2 msg="vd-root received a packet (proto=1, 10.72.55.240:1-1071.55.10:8)

from internal."
id=20085 trace_id=2 msg="Find an existing session, id-00001cd3, original direction"
id=20085 trace_id=2 msg="enter IPsec ="encrypted, and send to 15.215.225.22 with source

66.236.56.226“ tunnel-RemotePhase1"
id=20085 trace_id=2 msgid=20085 trace_id=2 msg="send to 66.236.56.230 via intf-wan1"

Packet sniffing and packet capture

When you troubleshoot networks, it helps to look inside the header of the packets. This helps to determine if the
packets, route, and destination are all what you expect. Packet capture can also be called a network tap, packet
sniffing, or logic analyzing. FortiOS devices can sniff packets using CLI commands or capture packets using the
GUI.
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Packet sniffing using CLI commands is well-suited for spot checking traffic, but if you have complex filters to enter
it can be a lot of work to enter them each time. You can also save the sniffing output. However, you must log to a
file and then analyze the file later.

Packet capture in the GUI makes it easy for you to set up multiple filters at once and run only one or two as you
need to. You can also use controls to start and stop capturing when you want to. You download packet capture
output to your local computer as a *.pcap file. You must use a third party application, such asWireshark, to read
*.pcap files. This method is useful to send information to Fortinet support to help resolve an issue.

The following table presents a comparison between the two methods:

Features Packet sniffing Packet capture

Command location CLI GUI

Third party software required puTTY to log plaintext output
Wireshark, or similar
application, to read *.pcap
files

Read output in plain text file yes no

Read output as *.pcap file using
Wireshark, or similar application no yes

Easily configure single quick and simple
filter

yes no

Record packet interface yes no

Configure complex sniffer filters on
multiple interface

no yes

sniff IPv6 hard easy

sniff non-IP packets no yes

Filter packets by protocol and/or port easy easy

Filter packets by source and/or
destination address

easy easy

Packet sniffing

If you're running a constant traffic application, such as ping, packet sniffing can tell you if the traffic is reaching
the destination, what the port of entry is on the FortiGate unit, if the ARP resolution is correct, and if the traffic is
being sent back to the source as expected.

Sniffing packets can also tell you if the FortiGate is silently dropping packets for reasons such as Reverse Path
Forwarding (RPF). RPF, also called anti-spoofing, prevents an IP packet from being forwarded if its source IP
doesn't belong to a locally attached subnet (local interface) or isn't part of the routing between the FortiGate and
another source (static route, RIP, OSPF, BGP). Note that you can disable RPF by turning on asymmetric routing
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in the CLI (config system settings, set asymroute enable), but this disables stateful inspection
on the FortiGate and causes many features to be turned off.

If you configure virtual IP addresses on your FortiGate, it will use those addresses
instead of the physical IP addresses. You'll notice this when you're sniffing packets
because all the traffic uses the virtual IP addresses. This is due to the ARP update
that's sent out when the VIP address is configured.

Before you start sniffing packets on the CLI, you should prepare to capture the output to a file. A large amount of
data may scroll by and you won't be able to see it without first saving it to a file. One method is to use a terminal
program like puTTY to connect to the FortiGate CLI. Once the packet sniffing count is reached, you can end the
session and analyze the output in the file.

The general form of the internal FortiOS packet sniffer command is:

diagnose sniffer packet <interface_name> <‘filter’> <verbose> <count> <tsformat>

To stop the sniffer, type CTRL+C.

<interface_name> The name of the interface to sniff, such as “port1” or “internal”. This can
also be “any” to sniff all interfaces.

<‘filter’>

What to look for in the information the sniffer reads. “none” indicates no
filtering, and all packets are displayed as the other arguments indicate.

The filter must be inside single quotes (‘).

<verbose> The level of verbosity as one of:

1 - print header of packets
2 - print header and data from IP of packets
3 - print header and data from Ethernet of packets
4 - print header of packets with interface name

<count> The number of packets the sniffer reads before stopping. If you don't put a
number here, the sniffer will run until you stop it with <CTRL+C>.

<tsformat> The format of timestamp.
l a: absolute UTC time, yyyy-mm-dd hh:mm:ss.ms
l l: absolute LOCAL time, yyyy-mm-dd hh:mm:ss.ms
l otherwise: relative to the start of sniffing, ss.ms

For a simple sniffing example, enter the CLI command diagnose sniffer packet port1 none 1 3.
This displays the next three packets on the port1 interface using no filtering, and verbose level 1. At this verbosity
level, you can see the source IP and port, the destination IP and port, action (such as ack), and sequence
numbers.

In the output below, port 443 indicates these are HTTPS packets and that 172.20.120.17 is both sending and
receiving traffic.

Head_Office_620b # diagnose sniffer packet port1 none 1 3
interfaces=[port1]
filters=[none]
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0.545306 172.20.120.17.52989 -> 172.20.120.141.443: psh 3177924955 ack 1854307757

0.545963 172.20.120.141.443 -> 172.20.120.17.52989: psh 1854307757 ack 3177925808

0.562409 172.20.120.17.52988 -> 172.20.120.141.443: psh 4225311614 ack 3314279933

For a more advanced example of packet sniffing, the following commands will report packets on any interface
that are traveling between a computer with the host name of “PC1” and a computer with the host name of “PC2”.
With verbosity 4 and above, the sniffer trace displays the interface names where traffic enters or leaves the
FortiGate unit. Remember to stop the sniffer, type CTRL+C.

FGT# diagnose sniffer packet any "host <PC1> or host <PC2>" 4

or

FGT# diagnose sniffer packet any "(host <PC1> or host <PC2>) and icmp" 4

The following CLI command for a sniffer includes the ARP protocol in the filter which may be useful to
troubleshoot a failure in the ARP resolution (for example, PC2 may be down and not responding to the FortiGate
ARP requests).

FGT# diagnose sniffer packet any "host <PC1> or host <PC2> or arp" 4

Packet capture

Packet capture tells you what is happening on the network at a low level. This can be very useful for
troubleshooting problems, such as:

l Finding missing traffic
l Seeing if sessions are setting up properly
l Locating ARP problems such as broadcast storm sources and causes
l Confirming which address a computer is using on the network, if they have multiple addresses or are on multiple

networks
l Confirming routing is working as you expect
l Connecting wireless clients
l Missing PING packets
l A particular type of packet is having problems, such as UDP, which is commonly used for streaming video

If you're running a constant traffic application such as ping, packet capture can tell you if the traffic is reaching the
destination, how the port enters and exits the FortiGate, if the ARP resolution is correct, and if the traffic is
returning to the source as expected. You can also use packet switching to verify that NAT or other configuration is
translating addresses or routing traffic the way that you want it to.

Before you start capturing packets, you need to have a good idea of what you're looking for. Capture is used to
confirm or deny your ideas about what's happening on the network. If you try capture without a plan to narrow
your search, you can end up with too much data to effectively analyze. On the other hand, you need to capture
enough packets to really understand all of the patterns and behavior that you're examining.

To use packet capture, the FortiGate must have a disk. You can enable the capture-packet in the firewall
policy, using the following CLI commands:

config firewall policy
edit <id>
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set capture-packet enable
end

To configure packet capture filters, go to Network > Packet Capture.

When you add a packet capture filter, enter the following information and select OK.

Interface Select the interface to sniff from the drop-down menu.

You must select one interface. You can't change the interface without
deleting the filter and creating a new one, unlike the other fields.

Max Packets to Save

Enter the number of packets to capture before the filter stops.

This number can't be zero. You can halt the capturing before this number is
reached.

Enable Filters Select this option to specify filter fields

Host(s)

Enter the IP address of one or more hosts

Separate multiple hosts with commas. To enter a range, use a dash
without spaces, for example 172.16.1.5-172.16.1.15, or enter a subnet.

Port(s) Enter one or more ports to capture on the selected interface.

Separate multiple ports with commas. To enter a range, use a dash without
spaces, for example 88-90

VLAN(s)
Enter one or more VLANs (if any).

Separate multiple VLANs with commas.

Protocol Enter one or more protocols. Separate multiple protocols with commas. To
enter a range, use a dash without spaces, for example 1-6, 17, 21-25.

Include IPv6 Packets Select this option if you're troubleshooting IPv6 networking, or if your
network uses IPv6. Otherwise, leave it disabled.

Include Non-IP Packets The protocols in the list are all IP based except for ICMP (ping). To capture
non-IP based packets, select this feature. Examples of non-IP packets
include IPsec, IGMP, ARP, and ICMP.

If you select a filter, you have the option to start and stop packet capture in the edit window, or download the
captured packets. You can also see the filter status and the number of packets captured.

You can select the filter and start capturing packets. When the filter is running, the number of captured packets
increases until it reaches theMax Packet Count or you stop it. When the filter is running, you can't download the
output file.

When the packet capture is complete, you can download the *.pcap file. You must use a third party application,
such asWireshark, to read *,pcap files. This tool provides you with extensive analytics and the full contents of the
packets that were captured.
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To start, stop, or resume packet capture, use the symbols on the screen. These symbols are the same as those
used for audio or video playback. Hover over the symbol to reveal explanatory text. Similarly, to download the
*.pcap file, use the download symbol on the screen.

NPU-based interfaces

Many Fortinet products contain network processors, such as NP1, NP2, NP4, and NP6.

When you use the NPU-based interfaces, you can see only the initial session setup using the diagnose debug
flow command. If the session is correctly programmed into the ASIC (fastpath), the diagnose debug flow
command won't detect the packets that arrive at the CPU. If the NPU functionality is disabled, the CPU detects all
packets. However, you should only use this for troubleshooting purposes.

First, obtain the NP4 or NP6 ID and the port numbers, using the following command:

diagnose npu {np4|npu6}list

Sample output:

ID Model Slot Interface
0 On-board port1 fabric1 fabric3 fabric5
1 On-board fabric2 port2 base2 fabric4

Run the following commands:

diagnose npu {np4|npu6}fastpaf th disable <dev_id>

(where dev_id is the NP4 or NP6 number)

Then, run this command:

diagnose npu {np4|npu6}fastpath-sniffer enable port1

Sample output:

NP4 Fast Path Sniffer on port1 enabled

This causes all traffic on port1 of the network processor to be sent to the CPU. This means that you can take a
standard sniffer trace and use other diagnose commands, if it's a standard CPU-driven port.

These commands only apply to the newer NP4 and NP6 interfaces.

Debug command

Debugging output provides continuous, real-time event information. Debugging output continues until you stop or
reboot the unit. Debugging output can affect system performance and is continually generated even though
output might not be displayed in the CLI console.

Debugging information that's displayed in the console scrolls in the console display and may prevent you from
entering CLI commands, such as, the command to disable the debug display. To turn off debugging output as the
display scrolls by, press theá key to recall the recent diagnose debug command, press backspace, and type “0”,
and Enter.

To enable debug output display, use the following command:

diagnose debug enable
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Once you enable debug output display, specify the debuggin information that you require, using the following
command:

diagnose debug <option> <level>

Debug command options include the following:

enable Enable debug output

disable Disable debug output

info Show active debug level settings

reset Reset all debug level to default

report Report for tech support

crashlog Crash log info

config-error-log Configure error log info

sql-log-error SQL log database error info

application application

kernel kernel

remote-extender remote-extender

cli Debug CLI

cmdb-trace Trace CLI

rating Display rating info

authd Authentication daemon

fsso-polling FSSO active directory poll module

flow Trace packet flow in kernel

urlfilter urlfilter

admin Admin user

You can set the debug level at the end of the command. For example, typical values are 2 and 3:

diagnose debug application DHCPS 2
diagnose debug application spamfilter 2

Fortinet Support will advise you about which debugging level you should use.

Timestamps can be enabled to the debug output using the following command:
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diagnose debug console timestamp enable

When you finish examining the debug output, disable it, using the following command:

diagnose debug disable

Debug output example

This example shows the IKE negotiation for a secure logging connection from a FortiGate to a FortiAnalyzer.

diagnose debug reset
diagnose vpn ike log-filter src-addr4 192.168.11.2
diagnose debug enable

Sample output:

FGh_FtiLog1: IPsec SA connect 0 192.168.11.2->192.168.10.201:500, natt_mode=0 rekey=0
phase2=FGh_FtiLog1

FGh_FtiLog1: using existing connection, dpd_fail=0
FGh_FtiLog1: found phase2 FGh_FtiLog1
FGh_FtiLog1: IPsec SA connect 0 192.168.11.2 -> 192.168.10.201:500 negotiating
FGh_FtiLog1: overriding selector 225.30.5.8 with 192.168.11.2
FGh_FtiLog1: initiator quick-mode set pfs=1536...
FGh_FtiLog1: try to negotiate with 1800 life seconds.
FGh_FtiLog1: initiate an SA with selectors: 192.168.11.2/0.0.0.0->192.168.10.201,

ports=0/0, protocol=0/0
Send IKE Packet(quick_outI1):192.168.11.2:500(if0) -> 192.168.10.201:500, len=348
Initiator: sent 192.168.10.201 quick mode message #1 (OK)
FGh_FtiLog1: set retransmit: st=168, timeout=6.

In this example:

192.168.11.2->192.168.10.201:500 Source and destination gateway IP address

dpd_fail=0 Found existing Phase 1

pfs=1536... Create new Phase 2 tunnel

The execute tac report command

The execute tac report command runs an exhaustive series of diagnostic commands. It runs commands
that are only needed if you're using certain features like high availability (HA), VPN tunnels, or a modem. The
report takes a few minutes to finish because of the amount of output that's generated. If you're logging CLI output
logged to a file, you can run this command to familiarize yourself with the diagnostic commands.

When you call Fortinet Customer Support, you may be asked to use the output from this CLI command to provide
information about your FortiGate and its current state.

Other commands

ARP table

To view the ARP cache, use the following command:

get system arp
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To view the ARP cache in the system, use the following command:

diagnose ip arp list

Sample output:

index=14 ifname=internal 224.0.0.5 01:00:5e:00:00:05 state=00000040 use=72203
confirm=78203 update=72203 ref=1

index=13 ifname=dmz 192.168.3.100 state=00000020 use=1843 confirm=650179 update=644179
ref=2 ? VIP

index=13 ifname=dmz 192.168.3.109 02:09:0f:78:69:ff state=00000004 use=71743 confirm=75743
update=75743 ref=1

index=14 ifname=internal 192.168.11.56 00:1c:23:10:f8:20 state=00000004 use=10532
confirm=10532 update=12658 ref=4

To remove the ARP cache, use the following command:

execute clear system arp table

To remove a single ARP entry, use the following command:

diagnose ip arp delete <interface name> <IP address>

To add static ARP entries, use the following command:

config system arp-table

Time and date settings

Check time and date settings for log message timestamp synchronization (the Fortinet support group may
request this) and for certificates that have a time requirement to check for validity. Use the following commands:

execute time
current time is: 12:40:48
last ntp sync:Thu Mar 16 12:00:21 2006
execute date
current date is: 2006-03-16

To force synchronization with an NTP server, use the following command:

config system ntp
set ntpsync {enable|disable}

end

If all devices have the same time, it helps to correlate log entries from different devices.

IP address

There may be times when you want to verify that the IP addresses assigned to the FortiGate interfaces are what
you expect them to be. This is easily accomplished from the CLI, using the following command:

diagnose ip address list

The output from this command lists the IP address and mask (if available), the index of the interface (a type of
ID number), and the devname (the interface name) . While physical interface names are set, virtual interface
names can vary. A good way to use this command is to list all of the virtual interface names. For vsys_ha and
vsys_fgfm, the IP addresses are the local host, which are virtual interfaces that are used internally.

# diagnose ip address list
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IP=10.31.101.100->10.31.101.100/255.255.255.0 index=3 devname=internal
IP=172.20.120.122->172.20.120.122/255.255.255.0 index=5 devname=wan1
IP=127.0.0.1->127.0.0.1/255.0.0.0 index=8 devname=root
IP=127.0.0.1->127.0.0.1/255.0.0.0 index=11 devname=vsys_ha
IP=127.0.0.1->127.0.0.1/255.0.0.0 index=13 devname=vsys_fgfm

FortiOS ports
There are 65,535 ports in TCP and UDP stacks that applications can use when they communicate with each
other. Many of these ports are commonly known to be associated with specific applications or protocols. These
ports can be useful when you troubleshoot your network.

Use the following ports when you troubleshoot your FortiGate:

Port Functionality

UDP 53 DNS lookup, RBL lookup

UDP 53 or UDP 8888 FortiGuard Antispam or Web Filtering rating lookup

UDP 53 (default) or UDP 8888
and UDP 1027 or UDP 1031

FDN server list - source and destination port numbers vary by originating or
reply traffic

UDP 123 NTP synchronization

UDP 162 SNMP traps

UDP 514 SYSLOG - All FortiOS versions can use syslog to send log messages to
remote syslog servers

TCP 22 Configuration backup to FortiManager unit or FortiGuard Analysis and
Management Service

TCP 25 SMTP alert email, encrypted virus sample auto-submit

TCP 389 or TCP 636 LDAP or PKI authentication

TCP 443
FortiGuard Antivirus or IPS update - When you request updates from a
FortiManager, instead of directly from the FDN, you must reconfigure this
port must be as TCP 8890

TCP 443 FortiGuard Analysis and Management Service

TCP 514 FortiGuard Analysis and Management Service log transmission (OFTP)

TCP 514 SSL Management Tunnel to FortiGuard Analysis and Management Service

TCP 514 Quarantine, remote access to logs and reports on a FortiAnalyzer unit,
device registration with FortiAnalyzer units (OFTP)

TCP 1812 RADIUS authentication
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Port Functionality

TCP 8000 and TCP 8002 FSSO

TCP 10151 FortiGuard Analysis and Management Service contract validation

FortiAnalyzer and FortiManager ports
If you have a FortiAnalyzer or FortiManager on your network, you may need to use the following ports to
troubleshoot network traffic:

Port Functionality

UDP 53 DNS lookup

UDP 123 NTP synchronization

UDP 137-138 Windows share

UDP 162 SNMP traps

UDP 514 Syslog, log forwarding

TCP 21 or TCP 22 Log and report upload

TCP 25 SMTP alert email

TCP 389 or TCP 636 User name LDAP queries for reports

TCP 443 RVS update

TCP 1812 RADIUS authentication

TCP 3000 Log aggregation client

FortiGuard troubleshooting
The FortiGuard service provides updates to AntiVirus (AV), Antispam (AS), Intrusion Protection Services (IPS),
Webfiltering (WF), and more. The FortiGuard Distribution System (FDS) consists of a number of servers across
the world that provide updates to your FortiGate. Problems can occur with connection to FDS, and its
configuration on your local FortiGate. Some of the more common troubleshooting methods are listed here,
including:

l Troubleshooting process for FortiGuard updates
l FortiGuard server settings
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Troubleshooting process for FortiGuard updates

The following process shows the logical steps that you should take when you troubleshoot problems with
FortiGuard updates:

1. Does the device have a valid licence that includes these services?
Each device requires a valid FortiGuard license to access updates for some or all of these services. You can verify
the status of the support contract for your devices at the Fortinet Support website.

2. If the device is part of a "high availability (HA)" cluster, do all members of the cluster have the same
level of support?
As with the previous step, you can verify the support contract status for all of the devices in your HA cluster at the
Fortinet Support website.

3. Are services enabled on the device?
To see the FortiGuard information and status for a device, in the GUI go to System > FortiGuard. On that page
you can verify the status of each component, and enable each service (if required). If there are problems, see the
FortiGuard discussion in the Fortinet Communication Ports and Protocols chapter of the FortiOS Handbook.

4. Can the device communicate with FortiGuard servers?
Go to System > FortiGuard in the GUI and try to update AV and IPS, or test the availability of WF and AS
default and alternate ports. If you encounter problems, see the FortiGuard discussion in the Fortinet
Communication Ports and Protocols chapter of the FortiOS Handbook.

5. Is there proper routing to reach the FortiGuard servers?
Ensure there is a static or dynamic route that allows your FortiGate to reach the FortiGuard servers. Usually a
generic default route to the internet is enough, but you may need to verify this if your network is complex.

6. Are there issues with DNS?
An easy way to test this is to attempt a traceroute from behind the FortiGate to an external network using the Fully
Qualified Domain Name (FQDN) for a location. If the traceroute FQDN name doesn't resolve, you have general
DNS problems.

7. Is there anything upstream that might be blocking FortiGuard traffic, either on the network or ISP
side?
Many firewalls block all ports, by default, and ISPs often block ports that are low. There may be a firewall between
the FortiGate and the FortiGuard servers that's blocking the traffic. FortiGuard uses port 53, by default, so if it's
being blocked you need to either open a hole for it or change the port it's using.

8. Is there an issue with source ports?
It's possible that ports that the FortiGate uses to contact FortiGuard are being changed before they reach
FortiGuard or on the return trip before they reach your FortiGate. A possible solution for this is to use a fixed-port
at NAT'd firewalls to ensure the port remains the same. You can use packet sniffing to find more information about
what's happening with ports.

9. Are there security policies that include antivirus?
If none of the security policies include antivirus, the antivirus database won't be updated. If antivirus is included,
only the database type that's used will be updated.

FortiGuard server settings

Your local FortiGate connects to remote FortiGuard servers to get updates to FortiGuard information, such as
new viruses that may have been found or other new threats. This section shows ways that you can to display
FortiGuard server information on your FortiGate, and how you can use that information and update it to fix
potential problems.
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Displaying the server list

The get webfilter status or diagnose debug rating command shows the list of FDS servers that
the FortiGate uses to send web filtering requests. Rating requests are only sent to the server at the top of the list
in normal operation. Each server is probed for Round Trip Time (RTT) every two minutes.

Optionally, you can add a refresh rate to the end of this command to determine how often the server list is
refreshed.

Rating may not be enabled on your FortiGate.

To show the list of servers a FortiGate uses to send web filtering requests - CLI

get webfilter status

Sample output:

Locale : english
License : Contract
Expiration : Thu Oct 9 02:00:00 2011
-=- Server List (Mon Feb 18 12:55:48 2008) -=-

IP Weight RTT Flags TZ Packets CurrLost TotalLost

a.b.c.d 0 1 DI 2 1926879 0 11176

10.1.101.1 10 329 1 10263 0 633

10.2.102.2 20 169 0 16105 0 80

10.3.103.3 20 182 0 6741 0 776

10.4.104.4 20 184 0 5249 0 987

10.5.105.5 25 181 0 12072 0 178

Output details

The server list includes the IP addresses of alternate servers if the first entry can't be reached. In this example,
the IP addresses are not public addresses.

The following flags in get webfilter status indicate the server status:

Flag Description

D The server was found through the DNS lookup of the hostname.

If the hostname returns more than one IP address, all of them are flagged with D and are
used first for INIT requests before falling back to the other servers.

I The server to which the last INIT request was sent

F The server hasn't responded to requests and is considered to have failed

3291 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 31 - Troubleshooting Troubleshooting tips

Flag Description

T The server is currently being timed

S Rating requests can be sent to the server

The flag is set for a server only in two cases:

1. The server exists in the servers list received from the FortiManager or any other
INIT server.

2. The server list received from the FortiManager is empty so the FortiManager is the
only server that the FortiGate knows, and it should be used as the rating server.

Sorting the server list

The server list is sorted first by weight. The server with the smallest RTT appears at the top of the list, regardless
of weight. When a packet is lost (there has been no response in 2 seconds), it's re-sent to the next server in the
list. Therefore, the top position in the list is selected based on RTT, while the other positions are based on
weight.

Calculating weight

The weight for each server increases with failed packets and decreases with successful packets. To lower the
possibility of using a remote server, the weight isn't allowed to dip below a base weight. The base weight is
calculated as the difference in hours between the FortiGate and the server multiplied by 10. The farther away the
server is, the higher its base weight is and the lower it appears in the list.

Troubleshooting tips

The following tips present common causes of problems.

How to check hardware connections

l Are all of the cables and interfaces connected properly?
l Is the LED for the interface green?

How to check FortiOS network settings

l If you're having problems connecting to the management interface, is your protocol enabled on the interface for
administrative access?

l Does the interface have an IP address?

How to check CPU and memory resources

l Is the FortiGate's CPU running at almost 100 percent usage?
l Is your FortiGate running low on memory?

How to check modem status

l Is the modem connected?
l Are there PPP issues?

How to run ping and traceroute
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l Is the FortiGate experiencing complete packet loss?

How to check the logs

l Do you need to identify a problem?

How to verify the contents of the routing table (in NAT mode)

l Are there routes in the routing table for default and static routes?
l Do all connected subnets have a route in the routing table?
l Does a route have a higher priority than it should?

How to verify the correct route is being used

l Is the traffic routed correctly?

How to verify the correct firewall policy is being used

l Is the correct firewall policy applied to the expected traffic?

How to check the bridging information in transparent mode

l Are you having problems in transparent mode?

How to check the number of sessions that UTM proxy uses

l Have you reached the maximum number of sessions for a protocol?
l Are new sessions failing to start for a certain protocol?

How to examine the firewall session list

l Are there active firewall sessions?

How to check wireless information

l Is the wireless network working properly?

How to verify connectivity to FortiGuard

l Is the FortiGate communicating properly with FortiGuard?

How to perform a sniffer trace (CLI and packet capture)

l Is traffic entering the FortiGate? Does the traffic arrive on the expected interface?
l Is the ARP resolution correct for the next-hop destination?
l Is the traffic exiting the FortiGate to the destination as expected?
l Is the FortiGate sending traffic back to the originator?

How to debug the packet flow

l Is traffic entering or leaving the FortiGate as expected?

How to check hardware connections
If there's no traffic flowing from the FortiGate, you may have a hardware problem.

To check hardware connections:

l Ensure network cables are plugged into the interfaces.
l Verify that the LED connection lights for the network cables are the right color (usually green).
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l If the cable or its connector are damaged, change the cable. You should also change the cable if you're not sure
about the type or quality of the cable, such as straight through or crossover, of if you see exposed wires at the
connector.

l Connect the FortiGate to different hardware.
l Ensure the link status is set to Up for the interface (see Network > Interfaces). The link status is based on the

physical connection and can't be set in FortiOS.

If any of these solve the problem, it was a hardware connection problem. You should still perform some basic
software connectivity tests to ensure complete connectivity. The interface might also be disabled, or its
Administrative Status is set to Down.

To enable an interface - GUI

1. Go to Network > Interfaces.
2. Select and edit the interface to enable, such as port1.
3. Find Administrative Status at the bottom of the screen, and select Up.
4. Select Apply.

To enable an interface - CLI

config system interface
edit port1

set status up
next

end

How to check FortiOS network settings
You can manage FortiOS network settings in the GUI and the CLI. The following information includes
troubleshooting and best practice information. The network settings include:

l Interface settings
l DNS settings
l DHCP server settings

Interface settings

If you can access the FortiGate with the management cable only, the first step is to display the interface settings.
To display the settings for the internal interface, use the following CLI command:

FGT# show system interface <interface_name>

For a complete listing of all the possible interface settings, use the following CLI command:

config system interface
edit <interface_name>
get

end

Check the interface settings to ensure that they aren't preventing traffic. Check the following items (only the GUI
terms are shown, CLI terms may vary):
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Setting Description

Link Status Down until a valid cable is plugged into this interface, then it will be Up.

The Link Status is shown physically by the connection LED for the interface. If
the LED is green, the connection is good. If Link Status isDown, the interface
doesn't work. Link Status is also displayed on the Network > Interfaces screen,
by default.

Addressing mode Don't use DHCP if you don’t have a DHCP server. You won't be able to log in to
to an interface in DHCPmode as it won't have an IP address

IP/Network Mask An interface needs an IP address to be able to connect to other devices. Ensure
there is a valid IP address in this field. The one exception is if DHCP is enabled
for this interface to get its IP address from an external DHCP server.

IPv6 address
The same protocol must be used by both ends to complete the connection.
Ensure both this interface and the remote connection are both using IPv4 or both
using IPv6 addressing.

Administrative access If no protocols are selected, you will have to use the local management cable to
connect to the unit. If you're using IPv6, configure the IPv6 administrative access
protocols.

Administrative status Set to Up or the interface won't work.

DNS settings

You can trace many networking problems back to DNS issues. Check the following items:

l Are there values for both primary and secondary entries?
l Is the local domain name correct?
l Are you using IPv6 addressing? If so, are the IPv6 DNS settings correct?
l Are you using Dynamic DNS (DDNS)? If so, is it using the correct server, credentials, and interface?
l Can you contact both DNS servers to verify the servers are operational?
l If an interface addressing mode is set to DHCP and is set to override the internal DNS, is that interface receiving a

valid DNS entry from the DHCP server? Is it a reasonable address and can it be contacted to verify it’s operational?
l Are there any DENY security policies that need to allow DNS?
l Can any internal device perform a successful traceroute to a location using the FQDN?

DHCP server settings

DHCP servers are common on internal and wireless networks. If the DHCP server isn't configured correctly, it can
cause problems. Check the following items:

l Is the DHCP server entry set to Relay? If so, verify there is another DHCP server to which requests can be relayed.
Otherwise, it should be set to Server.

l Is the DHCP server enabled?
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l Does the DHCP server use a valid IP address range? Are other devices using the addresses? If one or more devices
are using IP addresses in this range, you can use the IP reservation feature to ensure the DHCP server doesn't use
these addresses.

l Is there a gateway entry? If not, add a gateway entry to ensure that the server's clients have a default route.
l Is the system DNS setting being used? A best practice is to avoid confusion by using the system DNSwhenever

possible. However, you can specify up to three custom DNS servers, and you should use all three entries for
redundancy.

There are some situations, such as a new wireless interface, or during the initial
FortiGate configuration, where interfaces override the system DNS entries. When this
happens, it often shows up as intermittent Internet connectivity. To fix the problem, go
to Network > DNS and enable Use FortiGuard Servers.

How to check CPU and memory resources
System resources are shared and a number of processes run simultaneously on the FortiGate unit.

The Resourcewidgets forCPU andMemory on the Dashboard provide a quick way to monitor usage.

To use the CLI to check the system resources on your FortiGate unit, run the following command:

FGT# get system performance status

This command provides a quick and easy snapshot of the FortiGate.

The first line of output shows the CPU usage by category. A FortiGate that is doing nothing looks like the
following example:

CPU states: 0% user 0% system 0% nice 100% idle

However, if your network is running slowly, you might see something like the following example:

CPU states: 1% user 98% system 0% nice 1% idle

This line shows that all of the CPU is used up by system processes. Normally this shouldn't happen since it shows
that the FortiGate is overloaded for some reason. If you see this overloading, you should investigate further
because it’s possible that a process, such as scanunitid, is using all of the resources to scan traffic. In this
case, you must reduce the amount of traffic that's being scanned by blocking unwanted protocols, configuring
more security policies to limit scanning to certain protocols, or similar actions. It's also possible that a hacker has
gained access to your network and is overloading it with malicious activity, such as running a spam server or using
zombie PCs to attack other networks on the Internet. You can use the get system performance top CLI
command to get more information about the CPU. This command shows you all of the top processes that are
running on the FortiGate (the names are on the left) and their CPU usage. If a process is using most of the CPU
cycles, investigate it to determine whether the activity is normal.

The second line of output from the get system performance status command shows the memory
usage. Memory usage shouldn't exceed 90%. If memory is too full, some processes won't be able to function
properly. For example, if the system is running low on memory, antivirus scanning enters into failopen mode
where it drops connections or bypasses the antivirus system.

The other lines of output, such as average network usage, average session setup rate, viruses caught, and IPS
attacks blocked, can also help you determine why system resource usage is high. For example, if network usage
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is high, it results in high traffic processing on the FortiGate, or if the session setup rate is very low (or zero) the
proxy may be overloaded and unable to do its job.

How to troubleshoot high memory usage

As with any system, a FortiGate has limited hardware resources, such as memory, and all processes running on
the FortiGate share the memory. Each process uses more or less memory, depending on its workload. For
example, a process usually uses more memory in high traffic situations. If some processes use all of the available
memory, other processes won't be able to run.

When high memory usage occurs, the services may freeze up, connections may be lost, or new connections may
be refused.

If you see high memory usage in theMemorywidget, the FortiGate may be handling high traffic volumes.
Alternatively, the FortiGate may have connection pool limits that are affecting a single proxy. If the FortiGate
receives a large volume of traffic on a specific proxy, the unit may exceed the connection pool limit. If the number
of free connections within a proxy connection pool reaches zero, issues may occur.

Use the following CLI command, which uses the antivirus failopen feature:

config system global
set av-failopen idledrop

end

If you set av-failopen to idledrop, the FortiGate drops connections based on the clinets that have the
most open connections. This helps you determine the behavior of the FortiGate antivirus system if it becomes
overloaded in high traffic.

Use the following CLI command, which shows information about current memory usage:

diagnose hardware sysinfo memory

Sample output:

total: used: free: shared: buffers: cached: shm:
Mem: 2074185728 756936704 1317249024 0 20701184 194555904 161046528
Swap:       0       0       0
MemTotal:  2025572 kB
MemFree:    1286376 kB
MemShared:       0 kB
Buffers:    20216 kB
Cached: 189996 kB
SwapCached:       0 kB
Active:       56644 kB
Inactive:  153648 kB
HighTotal:       0 kB
HighFree:         0 kB
LowTotal:   2025572 kB
LowFree: 1286376 kB
SwapTotal:        0 kB
SwapFree: 0 kB

How to troubleshoot high CPU usage

If you deploy too many FortiOS features at the same time, you can overextend the CPU resources on a
FortiGate. When this occurs, the FortiGate experiences connection-related problems.
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Some examples of CPU intensive features are:

l VPN high-level encryption
l Intensive scanning of all traffic
l Logging all traffic and packets
l Dashboard widgets that frequently perform data updates

1. Determine the current level of CPU usage.
There are two ways to do this. The simplest is to look at the CPU widget on the Dashboard. The real-time CPU
usage is displayed for different timeframes. The second method provides precise usage values both for overall
usage and for specific processes. To use it, run the diagnose sys top command in the CLI.

Sample output:

Run Time: 86 days, 0 hours and 10 minutes
0U, 0N, 0S, 100I, 0WA, 0HI, 0SI, 0ST; 3040T, 2437F

bcm.user 93 S < 3.1 0.4
httpsd 18922 S 1.5 0.5
httpsd 19150 S 0.3 0.5
newcli 20195 R 0.1 0.1
cmdbsvr 115 S 0.0 0.8
pyfcgid 20107 S 0.0 0.6
forticron 146 S 0.0 0.5
httpsd 139 S 0.0 0.5
cw_acd 166 S 0.0 0.5
miglogd 136 S 0.0 0.5
pyfcgid 20110 S 0.0 0.4
pyfcgid 20111 S 0.0 0.4
pyfcgid 20109 S 0.0 0.4
httpsd 20192 S 0.0 0.4
miglogd 174 S 0.0 0.4
miglogd 175 S 0.0 0.4
fgfmd 165 S 0.0 0.3
newcli 20191 S 0.0 0.3
initXXXXXXXXXXX 1 S 0.0 0.3
httpsd 184 s 0.0 0.3

Where the codes on the second output line mean the following:

l U is the percentage of user space applications that are currently using the CPU.
l N is the percentage of time that the CPU spent on low priority processes since the last shutdown.
l S is the percentage of system processes (or kernel processes) that are using the CPU.
l I is the percentage of idle CPU resources.
l WA is the percentage of time that the CPU spent waiting on IO peripherals since the last shutdown.
l HI is the percentage of time that the CPU spent handling hardware interrupt routines since the last shutdown.
l SI is the percentage of time that the CPU spent handling software interrupt routines since the last shutdown.
l ST, or steal time, is the percentage of time that a virtual CPU waits for the physical CPU when the hypervisor is

servicing another virtual processor.
l T is the total FortiOS system memory, in MB.
l F is free memory, in MB.
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Each additional line of the command output displays information for specific processes running on the
FortiGate unit. For example, the third line of the output is:

newcli 20195 R 0.1 0.1

Where:

l newcli is the process name. Other process names can include ipsengine, sshd, cmdbsrv, httpsd,
scanunitd, and miglogd. Duplicate process names indicate that separate instances of that process are
running.

l 20195 is the process ID, which can be any number.
l R is the current state of the process. The process state can be:

l R - running
l S - sleep
l Z - zombie
l D - disk sleep

l 0.1 is the percentage of CPU capacity that the process is using. CPU usage can range from 0.0 for a process
that is sleeping to higher values for a process that's taking a lot of CPU time.

l 0.1 is the amount of memory that the process is using. Memory usage can range from 0.1 to 5.5 and higher.

When diagnose sys top is running, enter the following single-key commands :

l Press q to quit and return to the normal CLI prompt.
l Press p to sort the processes by the amount of CPU resources that the processes are using.
l Press m to sort the processes by the amount of memory that the processes are using.

The processes listed are the top processes that are running, and not all of the processes. For example, if 20
processes are listed, they are the top 20 processes, sorted by either CPU or memory usage. You can configure
the number of processes displayed, using the following CLI command:

diagnose sys top <integer_seconds> <integer_maximum_lines>

Where:

l <integer_seconds> is the delay in seconds (default is 5)
l <integer_maximum_lines> is the maximum number of lines (or processes) to list (default is 20).

2. Determine what features are using most of the CPU resources.
There is a command in the CLI that shows the top few processes that are currently running and use the most CPU
resources. The get system performance top CLI command shows a table of information. The second
column from the right shows CPU usage by percentage. If the top few entries are using most of the CPU, note
which processes they are and try and reduce their CPU load.

Some examples of processes you'll see include:
l ipsengine— the IPS engine that scans traffic for intrusions
l scanunitd— antivirus scanner
l httpsd— secure HTTP
l iked— internet key exchange (IKE) in use with IPsec VPN tunnels
l newcli— active whenever you're accessing the CLI
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l sshd— there are active secure socket connections
l cmdbsrv— the command database server application

Go to the features that are at the top of the list and look for evidence of them overusing the CPU.
Generally, the monitor for a feature is a good place to start.

3. Check for unnecessary CPU “wasters”.
These are some best practices that will reduce your CPU usage, even if the FortiGate isn't experiencing high CPU
usage.
l Use hardware acceleration wherever possible to offload tasks from the CPU. Offloading tasks, such as

encryption, frees up the CPU for other tasks.
l Avoid the use of GUI widgets that require computing cycles, such as the Top Sessions widget. These widgets

constantly poll the system for information, which uses CPU and other resources.
l Schedule antivirus, IPS, and firmware updates during off peak hours. These updates don't usually these don’t

consume CPU resources but they can disrupt normal operation.
l Check the log levels and which events are being logged. This is the severity of the messages that are recorded.

Consider going up one level to reduce the amount of logging. Also, if there are events you don't need to
monitor, remove them from the list.

l Log to FortiCloud instead of logging to memory or disk. Logging to memory quickly uses up resources and
logging to the local disk impacts overall performance and reduces the lifetime of the unit. Fortinet recommends
that you log to FortiCloud because it doesn’t use much CPU.

l If the disk is almost full, transfer the logs or data off the disk to free up space. When a disk is almost full it
consumes a lot of resources to find the free space and organize the files.

l If the FortiGate has packet logging enabled, consider disabling it. When packet logging is enabled, it records
every packet that comes through that policy.

l Halt all sniffers and traces.
l Ensure that the FortiGate isn't scanning traffic twice. If traffic enters the FortiGate on one interface, goes out

another, and then comes back in again, that traffic doesn't need to be rescanned. Doing so is a waste of
resources. However, ensure that traffic is being scanned once.

l Reduce the session timers to close unused sessions faster. Enter the following CLI commands, which reduce
the default values. These values reduce the values from defaults. Note tht, by default, the system adds 10
seconds to tcp-timewait.

config system global
set tcp-halfclose-timer 30
set tcp-halfopen-timer 30
set tcp-timewait-timer 0
set udp-idle-timer 60

end

l In System > Feature Visibility, only enable features that you need.

4. When CPU usage is under control, use SNMP to monitor CPU usage. Alternatively, use logging to record CPU and
memory usage every 5 minutes.
Once things are back to normal, you should set up a warning system that sends you alerts when CPU resources
are used excessively. A common method to do this is using SNMP. SNMPmonitors many values in FortiOS and
allows you to set high water marks that generate events. You run an application on your computer to watch for and
record these events. Go to System > SNMP to enable and configure an SNMP community. If this method is too
complicated, you can use the System Resourceswidget to record CPU usage. However, this method only
records problems as they happen and won't send you alerts for problems.
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How to check modem status
If the modem doesn't work properly, or a FortiGate doesn't detect the modem, you can use the following
diagnostic command to help you troubleshoot issues with the modem:

diagnose sys modem {cmd | com | detect | history | external-modem | query| reset}

You should always run the following diagnose command after you insert the USBmodem into the FortiGate:

diagnose sys modem detect

You can view the modem configuration, using the get system modem command. You can also view the
modem’s vendor and the custom product identification number from the information output that the get
system modem command shows.

If there are connectivity issues, use the following to help you resolve them:

l diagnose debug enable – activates the debug on the console
l diagnose debug application modemd – dumps communication between the modem and the unit.
l diagnose debug application ppp – dumps the PPP negotiating messages.
l execute modem dial – displays modem debug output.

The modem diagnose output shouldn't contain errors on the way to initializing. You should also verify the number
that is used to dial into your ISP.

How to run ping and traceroute
Ping and traceroute are useful tools in network troubleshooting. Alone, either one can determine network
connectivity between two points. However, ping can be used to generate simple network traffic that you can view
using diagnose commands on the FortiGate. This combination can be very powerful when you're trying to locate
network problems.

In addition to their normal uses, ping and traceroute can tell you if your computer or network device has access to
a domain name server (DNS). While both tools can use IP addresses alone, they can also use domain names for
devices. This is an added troubleshooting feature that can be useful in determining why particular services, such
as email or web browsing, may not work properly.

If ping doesn't work, it may be disabled on at least one of the interface settings, and
security policies for that interface.

Both ping and traceroute require particular ports to be open on firewalls, or else they can't function. Since you
typically use these tools to troubleshoot, you can allow them in the security policies and on interfaces only when
you need them. Otherwise, keep the ports disabled for added security.

Ping

The ping command sends a very small packet to a destination, and waits for a response. The response has a
timer that expires when the destination is unreachable.

Ping is part of Layer 3 on the OSI Networking Model. Ping sends Internet Control Message Protocol (ICMP) “echo
request” packets to the destination, and listens for “echo response” packets in reply. However, many public
networks block ICMP packets because ping can be used in a denial of service (DoS) attack (such as Ping of Death
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or a smurf attack), or by an attacker to find active locations on the network. By default, FortiGate units have ping
enabled while broadcast-forward is disabled on the external interface.

What ping can tell you

Beyond the basic connectivity information, ping can tell you the amount of packet loss (if any), how long it takes
the packet to make the round trip, and the variation in that time from packet to packet.

If there is some packet loss detected, you should investigate the following:

l Possible ECMP, split horizon, or network loops.
l Cabling, to ensure no loose connections.
l Verify which security policy was used (use the packet count column on the Policy & Objects > IPv4 Policy or
Policy & Objects > IPv6 Policy page).

If there is total packet loss, you should investigate the following:

l Hardware: ensure cabling is correct, and all equipment between the two locations is accounted for.
l Addresses and routes: ensure all IP addresses and routing information along the route is configured as expected.
l Firewalls: ensure all firewalls, including FortiGate security policies allow PING to pass through.

How to use ping

Ping syntax is the same for nearly every type of system on a network.

To ping from a FortiGate

1. Connect to the CLI either through telnet or through the CLI widget on the Dashboard .
2. Enter execute ping 10.11.101.101 to send 5 ping packets to the destination IP address. There are no

options for this command.

Sample output:
Head_Office_620b # execute ping 10.11.101.101
PING 10.11.101.101 (10.11.101.101): 56 data bytes
64 bytes from 10.11.101.101: icmp_seq=0 ttl=255 time=0.3 ms
64 bytes from 10.11.101.101: icmp_seq=1 ttl=255 time=0.2 ms
64 bytes from 10.11.101.101: icmp_seq=2 ttl=255 time=0.2 ms
64 bytes from 10.11.101.101: icmp_seq=3 ttl=255 time=0.2 ms
64 bytes from 10.11.101.101: icmp_seq=4 ttl=255 time=0.2 ms

--- 10.11.101.101 ping statistics ---
5 packets transmitted, 5 packets received, 0% packet loss
round-trip min/avg/max = 0.2/0.2/0.3 ms

To ping from an MicroSoft Windows PC

1. Open a command window.
2. Enter ping 10.11.101.100 to ping the default internal interface of the FortiGate with four packets.

Other options include:

l -t to send packets until you press “Ctrl+C”
l -a to resolve addresses to domain names where possible
l -n X to send X ping packets and stop
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Sample output:
C:\>ping 10.11.101.101

Pinging 10.11.101.101 with 32 bytes of data:
Reply from 10.11.101.101: bytes=32 time=10ms TTL=255
Reply from 10.11.101.101: bytes=32 time<1ms TTL=255
Reply from 10.11.101.101: bytes=32 time=1ms TTL=255
Reply from 10.11.101.101: bytes=32 time=1ms TTL=255

Ping statistics for 10.11.101.101:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip times in milli-seconds:
Minimum = 0ms, Maximum = 10ms, Average = 3ms

To ping from a Linux PC

1. Go to a shell prompt.
2. Enter “ping 10.11.101.101”.

Traceroute

Where ping will only tell you if it reached its destination and returned successfully, traceroute shows each step of
the journey to its destination and how long each step takes. If ping finds an outage between two points, you can
use traceroute to locate exactly where the problem is.

What's traceroute

Traceroute works by sending ICMP packets to test each hop along the route. It sends three packets, and then
increases the time to live (TTL) setting by one each time. This effectively allows the packets to go one hop farther
along the route. This is the reason why most traceroute commands display their maximum hop count before they
start tracing the route, which is the maximum number of steps it takes before it declares the destination
unreachable. Also, the TTL setting may result in steps along the route timing out due to slow responses. There
are many possible reasons for this to occur.

By default, traceroute uses UDP datagrams with destination ports numbered from 33434 to 33534. The
traceroute utility may also offer the option to select use of ICMP echo request (type 8) instead, which the
Windows tracert utility uses. If you must, allow both protocols inbound through the FortiGate security policies
(UDPwith ports from 33434 to 33534 and ICMP type 8).

You can also use the packet count column of the Policy & Objects > IPv4 Policy (or Policy & Objects
> IPv6 Policy, if applicable) page to track traceroute packets. This allows you to verify the connection and
confirm which security policy the traceroute packets are using.

What traceroute can tell you

Ping and traceroute have similar functions, which is to verify connectivity between two points. The big difference
is that traceroute shows you each step of the way, where ping doesn't. Also, ping and traceroute use different
protocols and ports, so one may succeed where the other fails.

You can verify your DNS connection using traceroute. If you enter an FQDN instead of an IP address for the
traceroute, DNS tries to resolve that domain name. If the name isn't resolved, you have DNS issues.
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How to use traceroute

The traceroute command varies slightly between operating systems. Note that in MicroSoft Windows, the
command name is shortened to “tracert”. Also, your output lists different domain names and IP addresses
along your route.

To use traceroute on an MicroSoft Windows PC

1. Open a command window.
2. Enter “tracert fortinet.com” to trace the route from the PC to the Fortinet web site.

Sample output:
C:\>tracert fortinet.com

Tracing route to fortinet.com [208.70.202.225]
over a maximum of 30 hops:
1 <1 ms <1 ms <1 ms 172.20.120.2
2 66 ms 24 ms 31 ms 209-87-254-xxx.storm.ca [209.87.254.221]
3 52 ms 22 ms 18 ms core-2-g0-0-1104.storm.ca [209.87.239.129]
4 43 ms 36 ms 27 ms core-3-g0-0-1185.storm.ca [209.87.239.222]
5 46 ms 21 ms 16 ms te3-x.1156.mpd01.cogentco.com [38.104.158.69]
6 25 ms 45 ms 53 ms te8-7.mpd01.cogentco.com [154.54.27.249]
7 89 ms 70 ms 36 ms te3-x.mpd01.cogentco.com [154.54.6.206]
8 55 ms 77 ms 58 ms sl-st30-chi-.sprintlink.net [144.232.9.69]
9 53 ms 58 ms 46 ms sl-0-3-3-x.sprintlink.net [144.232.19.181]
10 82 ms 90 ms 75 ms sl-x-12-0-1.sprintlink.net [144.232.20.61]
11 122 ms 123 ms 132 ms sl-0-x-0-3.sprintlink.net [144.232.18.150]
12 129 ms 119 ms 139 ms 144.232.20.7
13 172 ms 164 ms 243 ms sl-321313-0.sprintlink.net [144.223.243.58]
14 99 ms 94 ms 93 ms 203.78.181.18
15 108 ms 102 ms 89 ms 203.78.176.2
16 98 ms 95 ms 97 ms 208.70.202.225

Trace complete.

The first column on the left shows the hop count, which can't exceed 30 hops. When that number is reached, the
traceroute ends.

The second, third, and fourth columns display how much time each of the three packets takes to reach this stage
of the route. These values are in milliseconds and normally vary quite a bit. Typically a value of <1ms indicates a
local connection.

The fifth column (farthest to the right) shows the domain name of the device and its IP address, or possibly only
the IP address.

To perform a traceroute on a Linux PC

1. Go to a command line prompt.
2. Enter “traceroute fortinet.com”.

The Linux traceroute output is very similar to the MicroSoft Windows tracert output.

To trace a route from a FortiGate to a destination IP address - CLI

# execute traceroute www.fortinet.com
traceroute to www.fortinet.com (66.171.121.34), 32 hops max, 84 byte packets
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1 172.20.120.2 0.637 ms 0.653 ms 0.279 ms
2 209.87.254.221 <static-209-87-254-221.storm.ca> 2.448 ms 2.519 ms 2.458 ms
3 209.87.239.129 <core-2-g0-2.storm.ca> 2.917 ms 2.828 ms 9.324 ms
4 209.87.239.199 <core-3-bdi1739.storm.ca> 13.248 ms 12.401 ms 13.009 ms
5 216.66.41.113 <v502.core1.tor1.he.net> 17.181 ms 12.422 ms 12.268 ms
6 184.105.80.9 <100ge1-2.core1.nyc4.he.net> 21.355 ms 21.518 ms 21.597 ms
7 198.32.118.41 <ny-paix-gni.twgate.net> 83.297 ms 84.416 ms 83.782 ms
8 203.160.228.217 <217-228-160-203.TWGATE-IP.twgate.net> 82.579 ms 82.187 ms 82.066 ms
9 203.160.228.229 <229-228-160-203.TWGATE-IP.twgate.net> 82.055 ms 82.455 ms 81.808 ms
10 203.78.181.2 82.262 ms 81.572 ms 82.015 ms
11 203.78.186.70 83.283 ms 83.243 ms 83.293 ms
12 66.171.127.177 84.030 ms 84.229 ms 83.550 ms
13 66.171.121.34 <www.fortinet.com> 84.023 ms 83.903 ms 84.032 ms
14 66.171.121.34 <www.fortinet.com> 83.874 ms 84.084 ms 83.810 ms

How to check the logs
You might forget this step in troubleshooting, but it's an important one. Logging records the traffic that passes
through the FortiGate to your network and what action the FortiGate takes when it scans the traffic. This
information record is called a log message.

When you first configure FortiOS, log as much information as you can. If the logs that the FortiGatte generates
are too large, you can turn off or scale back the logging for features that you're not using.

As with most troubleshooting steps, before you can determine if the logs indicate a problem, you need to know
what logs result from normal operation. Without a baseline it's difficult to troubleshoot.

When you troubleshoot with log files:

l Compare current logs to a recorded baseline of normal operation.
l If you need to increase the level of logging (for example, from Warning to Information) to obtain more information.

When you increase logging levels, ensure that you configure email alerts and select both disk usage and log
quota. This ensures that you'll be notified if the increase in logging causes problems. Configure log settings by
going to Log & Report > Log Settings.

Determine the activities that generate the most log entries:

l Check all logs to ensure important information isn't overlooked.
l Filter or order log entries based on different fields, such as level, service, or IP address, to look for patterns that may

indicate a specific problem, such as frequent blocked connections on a specific port for all IP addresses.

Logs help identify and locate any problems, but they won't solve the problems. The purpose of logs is to speed up
your problem solving and save you time and effort.

How to verify the contents of the routing table (in NAT mode)
When a FortiGate has limited or no connectivity, a good place to look for information is the routing table.

The routing table is where all the currently used routes are stored for both static and dynamic protocols. If a route
is in the routing table, it saves time and resources that you would spend performing a lookup. If the routing table
is full and a new route needs to be added, the oldest, least-used route is removed and the new route is added.
This ensures that the most recently used routes stay in the table. If your FortiGate is in transparent mode, you
can't perform this step.
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If the FortiGate is running in NAT mode, verify that all desired routes are in the routing table, including local
subnets, default routes, specific static routes, and dynamic routing protocols.

To check the routing table in the FortiGate GUI, use the Routing Monitor by going toMonitor > Routing
Monitor.
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In the CLI, use the command get router info routing-table all.

Sample output:
FGT# get router info routing-table all

Codes:
K - kernel, C - connected, S - static, R - RIP, B - BGP
O - OSPF, IA - OSPF inter area
N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2
E1 - OSPF external type 1, E2 - OSPF external type 2
i - IS-IS, L1 - IS-IS level-1, L2 - IS-IS level-2, ia - IS-IS inter area
* - candidate default

S* 0.0.0.0/0 [10/0] via 172.20.120.2, wan1
C 10.31.101.0/24 is directly connected, internal
C 172.20.120.0/24 is directly connected, wan1

How to verify the correct route is being used
If you have more than one default route and want to make sure that traffic is flowing as expected and through the
right route, you can run a trace route from a machine in the local area network (LAN). This shows you the first hop
that the traffic goes through.

Sample output:

C:\>tracert www.fortinet.com

Tracing route to www.fortinet.com [66.171.121.34]
over a maximum of 30 hops:

1 <1 ms <1 ms <1 ms 10.10.1.99
2 1 ms <1 ms <1 ms 172.20.120.2
3 3 ms 3 ms 3 ms static-209-87-254-221.storm.ca [209.87.254.221]
4 3 ms 3 ms 3 ms core-2-g0-2.storm.ca [209.87.239.129]
5 13 ms 13 ms 13 ms core-3-bdi1739.storm.ca [209.87.239.199]
6 12 ms 19 ms 11 ms v502.core1.tor1.he.net [216.66.41.113]
7 22 ms 22 ms 21 ms 100ge1-2.core1.nyc4.he.net [184.105.80.9]
8 84 ms 84 ms 84 ms ny-paix-gni.twgate.net [198.32.118.41]
9 82 ms 84 ms 82 ms 217-228-160-203.TWGATE-IP.twgate.net [203.160.22
8.217]
10 82 ms 81 ms 82 ms 229-228-160-203.TWGATE-IP.twgate.net [203.160.22
8.229]
11 82 ms 82 ms 82 ms 203.78.181.2
12 84 ms 83 ms 83 ms 203.78.186.70
13 84 ms * 85 ms 66.171.127.177
14 84 ms 84 ms 84 ms fortinet.com [66.171.121.34]
15 84 ms 84 ms 83 ms fortinet.com [66.171.121.34]

Trace complete.

In this scenario, the first hop contains the IP address 10.10.1.99, which is the internal interface of the
FortiGate. The second hop contains the IP address 172.20.120.2, to which the wan1 interface of the
FortiGate is connected, so we can conclude that the route through wan1 interface is being used for this traffic.
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You can also see the route taken for each session by debugging the packet flow in the CLI. For more information,
see How to debug the packet flow.

How to verify the correct firewall policy is being used
If you have more than one firewall policy, use the count column to check which policy is being used, the count
must show traffic increasing. To do so, go to the Policy & Objects > IPv4 Policy or Policy & Objects > IPv6
Policy page.

Also, debugging the packet flow in the CLI shows the policy ID that's allowing the traffic. For more information on
debugging the packet flow, see How to debug the packet flow.

How to check the bridging information in transparent mode
When the FortiGate is set to transparent mode, it acts like a bridge and sends all incoming traffic out on the other
interfaces. The bridge is between interfaces on the FortiGate.

Each bridge that's listed is a link between interfaces. Where traffic is flowing between interfaces, you can expect
to find bridges listed. If you're having connectivity issues, and there are no bridges listed, that is a likely cause.
Check for the MAC address of the interface or device in question.

How to check the bridging information

To list the existing bridge instances on the FortiGate, use the following command:

diagnose netlink brctl list

Sample output:

#diagnose netlink brctl list
list bridge information
1. root.b fdb: size=256 used=6 num=7 depth=2 simple=no
Total 1 bridges

How to display forwarding domain information

You can use forwarding domains, or collision domains, in routing to limit where packets are forwarded on the
network. Layer 2 broadcasts are limited to the same group. By default, all interfaces are in group 0. For example,
if the FortiGate has 12 interfaces, only two may be in the same forwarding domain, which limits the packets that
are broadcast to those two interfaces. This reduces traffic on the rest of the network.

Collision domains prevent the forwarding of ARP packets to all VLANs on an interface. Without collision domains,
duplicate MAC addresses on VLANsmay cause ARP packets to be duplicated. Duplicate ARP packets can cause
some switches to reset. It's important to know what interfaces are part of which forwarding domains because this
determines which interfaces can communicate with each other.

To manually configure forwarding domains in transparent mode, use the following CLI command:

config system interface
edit <interface_name>
set forward-domain <integer>

end

To display the information for forward domains, use the following command:

diagnose netlink brctl domain <name> <id>
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where <name> is the name of the forwarding domain to display and <id> is the domain ID.

Sample output

diagnose netlink brctl domain ione 101
show bridge root.b ione forward domain.
id=101 dev=trunk_1 6

To list the existing bridge MAC table, use the following command:

diagnose netlink brctl name host <name>

Sample output

show bridge control interface root.b host.
fdb: size=256, used=6, num=7, depth=2, simple=no
Bridge root.b host table

port no device devname mac addr ttl attributes

2 7 wan2 02:09:0f:78:69:00 0
Local
Static

5 6 vlan_1 02:09:0f:78:69:01 0
Local
Static

3 8 dmz 02:09:0f:78:69:01 0
Local
Static

4 9 internal 02:09:0f:78:69:02 0
Local
Static

3 8 dmz 00:80:c8:39:87:5a 194

4 9 internal 02:09:0f:78:67:68 8

1 3 wan1 00:09:0f:78:69:fe 0
Local
Static

To list the existing bridge port list, use the following command:

diagnose netlink brctl name port <name>

Sample output:

show bridge root.b data port.
trunk_1 peer_dev=0
internal peer_dev=0
dmz peer_dev=0
wan2 peer_dev=0
wan1 peer_dev=0

How to check the number of sessions that UTM proxy uses
Each FortiGate model has a limit to the maximum number of sessions that the UTM proxy supports. The UTM
proxy handles all the traffic for the following protocols: HTTP, SMTP, POP3, IMAP, FTP, and NNTP. If the proxy
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for a protocol fills up its session table, the FortiGate enters conserve mode, where it behaves differently, until
entries and memory free up again.

Conserve or failopen mode

Once you reach the limit, depending on the conserve mode configuration, no new sessions are created until old
ones end. You can configure the behavior of the FortiGate when memory is running low or the proxy connection
limit has been reached. There are two related commands for this in the CLI:

config system global
set av-failopen-session {enable | disable}
set av-failopen {idledrop | off | one-shot | pass}

end

To set the behavior for these conditions, you must enable av-failopen-session. When it's enabled, and a
proxy for a protocol runs out of room in its session table, that protocol goes into failopen mode and behaves as
defined in the av-failopen command.

av-failopen determines the behavior of the proxy until entries are free in the session table again for that
proxy.

l idledrop — This option removes idle sessions from the session table, starting with the clients that have the
most sessions currently open. This method assumes that idle sessions aren't being used and it won't cause
problems to close these sessions. This is usually true, but some applications may be unable to open a session. If
this occurs, try another method to check if this is really the problem. This is a secure option as no unscanned traffic
is allowed to pass.

l off — This option turns off accepting any new AV sessions, but continues to process any existing AV sessions
that are currently active. All the protocols listed (HTTP, SMTP, POP3, IMAP, FTP, and NNTP) are scanned by
FortiGate Antivirus. If AV scanning is enabled, av-failopen off is selected, and the proxy session table fills up, which
means that no new sessions of that type are accepted. For example, if the POP3 session table is full, and email AV
scanning is enabled, no additional POP3 connections are allowed until the session table gets some free space. This
is a secure option because no unscanned traffic is allowed to pass.

l one-shot — When memory is low, bypass the antivirus system. The term one-shot comes from the fact that
once you're in one-shot av-failopen mode, you must set av-failopen to either pass or off to restart AV
scanning. This is a very unsecure option because it allows all traffic without AV scanning, and it never reverts to
normal without manual assistance.

l pass —When memory is low, bypass the antivirus system. The difference between pass and one-shot
options is that when memory is freed up, the system automatically starts AV scanning. This is an unsecure option
because it allows traffic to pass without AV scanning. However, it's better than one-shot because it automatically
restarts AV scanning, when possible.

If the proxy session table is full for one or more protocols and your FortiGate enters into conserve or failopen
mode, it appears as though the FortiGate has lost connection, network services are intermittent or don't exist,
and yet other services work normally for a while until their sessions end and they join the queue of session-starved
applications.

How to examine the firewall session list
The firewall session list displays all sessions that the FortiGate has open. You can see if there are strange
patterns, such as no sessions apart from the internal network, or all sessions are only to one IP address.
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When you examine the firewall session list in the CLI, you can use filters to reduce the output. In the GUI, the
filters belong to the interface.

To examine the firewall session list - GUI

Go to FortiView > All Sessions.

To examine the firewall session list - CLI

When you examine the firewall session list, there may be too many sessions to display. In this case, it's necessary
to limit or filter the sessions displayed by source or destination address, or NAT'd address or port. If you want to
filter by more than one of these, you need to enter a separate line for each value.

The following example shows filtering the session list based on a source address of 10.11.101.112:

FGT# diagnose sys session filter src 10.11.101.112
FGT# diagnose sys session list

The following example shows filtering the session list based on a destination address of 172.20.120.222:

FGT# diagnose sys session filter dst 172.20.120.222
FGT# diagnose sys session list

To clear all sessions corresponding to a filter - CLI

FGT# diagnose sys session filter dst 172.20.120.222
FGT# diagnose sys session clear

Check source NAT information

When you troubleshoot connections, remember NAT. NAT is especially important if you're troubleshooting from
the remote end of the connection outside the firewall. On the FortiView > All Sessions list, pay attention to
NAT Source, and NAT Source Port. These columns display the IP and port values after NAT has been
applied.

Checking the NAT values can help you ensure that they are the values you expect, and that the remote end of the
sessions can see the expected IP address and port number.

When you display the session list in the CLI, you can match the NAT'd source address (nsrc) and port (nport).
This can be useful if multiple internal IP addresses are NAT'd to a common external-facing source IP address.

FGT# diagnose sys session filter nsrc 172.20.120.122
FGT# diagnose sys session filter nport 8888
FGT# diagnose sys session list

How to check wireless information
Wireless connections, stations, and interfaces have different issues than other physical interfaces.

Troubleshooting station connection issue

To check whether a station entry is created on access control, use the following command:

FG600B3909600253 # diagnose wireless-controller wlac -d sta
* vf=0 wtp=70 rId=2 wlan=open ip=0.0.0.0 mac=00:09:0f:db:c4:03 rssi=0 idle=148 bw=0 use=2
vf=0 wtp=70 rId=2 wlan=open ip=172.30.32.122 mac=00:25:9c:e0:47:88 rssi=-40 idle=0 bw=9

use=2
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Enable diagnostics for a particular station

This example uses the station MAC address to find where it's failing:

FG600B3909600253 # diagnose wireless-controller wlac sta_filter 00:25:9c:e0:47:88 1
Set filter sta 00:25:9c:e0:47:88 level 1
FG600B3909600253 # 71419.245 <ih> IEEE 802.11 mgmt::disassoc <== 00:25:9c:e0:47:88 vap

open rId 1 wId 0 00:09:0f:db:c4:03
71419.246 <dc> STA del 00:25:9c:e0:47:88 vap open rId 1 wId 0
71419.246 <cc> STA_CFG_REQ(34) sta 00:25:9c:e0:47:88 del ==> ws (0-192.168.35.1:5246) rId

1 wId 0
71419.246 <cc> STA del 00:25:9c:e0:47:88 vap open ws (0-192.168.35.1:5246) rId 1 wId 0

00:09:0f:db:c4:03 sec open reason I2C_STA_DEL
71419.247 <cc> STA_CFG_RESP(34) 00:25:9c:e0:47:88 <== ws (0-192.168.35.1:5246) rc 0

(Success).

How to verify connectivity to FortiGuard
You can verify connectivity to FortiGuard in the Licenseswidget on the Dashboard. When your FortiGate is
connected to FortiGuard, a green check mark appears for available FortiGuard services.

To verify connectivity to FortiGuard using the CLI, enter the commands execute ping
service.fortiguard.net and execute ping update.fortiguard.net.

Sample output:

FG100D# execute ping service.fortiguard.net
PING guard.fortinet.net (208.91.112.196): 56 data bytes
64 bytes from 208.91.112.196: icmp_seq=0 ttl=51 time=61.0 ms
64 bytes from 208.91.112.196: icmp_seq=1 ttl=51 time=60.0 ms
64 bytes from 208.91.112.196: icmp_seq=2 ttl=51 time=59.6 ms
64 bytes from 208.91.112.196: icmp_seq=3 ttl=51 time=58.9 ms
64 bytes from 208.91.112.196: icmp_seq=4 ttl=51 time=59.2 ms

--- guard.fortinet.net ping statistics ---
5 packets transmitted, 5 packets received, 0% packet loss
round-trip min/avg/max = 58.9/59.7/61.0 ms

FG100D# execute ping update.fortiguard.net
PING fds1.fortinet.com (208.91.112.68): 56 data bytes
64 bytes from 208.91.112.68: icmp_seq=0 ttl=53 time=62.0 ms
64 bytes from 208.91.112.68: icmp_seq=1 ttl=53 time=61.8 ms
64 bytes from 208.91.112.68: icmp_seq=2 ttl=53 time=61.3 ms
64 bytes from 208.91.112.68: icmp_seq=3 ttl=53 time=61.9 ms
64 bytes from 208.91.112.68: icmp_seq=4 ttl=53 time=61.8 ms

How to perform a sniffer trace (CLI and packet capture)
When you troubleshoot networks and routing in particular, it helps to look inside the headers of packets to
determine if they're traveling along the route that you expect them to take. Packet sniffing can also be called a
network tap, packet capture, or logic analyzing.

If your FortiGate has NP2, NP4, or NP6 interfaces that are offloading traffic, this will
change the sniffer trace. Before performing a trace on any NP2, NP4, or NP6
interfaces, you should disable offloading on those interfaces.
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How do you sniff packets

Before you start sniffing packets on the CLI, you should prepare to capture the output to a file. A large amount of
data may scroll by and you won't be able to see it without first saving it to a file. One method is to use a terminal
program like puTTY to connect to the FortiGate CLI. Once the packet sniffing count is reached, you can end the
session and analyze the output in the file.

The general form of the internal FortiOS packet sniffer command is:

diagnose sniffer packet <interface_name> <‘filter’> <verbose> <count> <tsformat>

To stop the sniffer, type CTRL+C.

<interface_name> The name of the interface to sniff, such as “port1” or “internal”. This can
also be “any” to sniff all interfaces.

<‘filter’>

What to look for in the information the sniffer reads. “none” indicates no
filtering, and all packets are displayed as the other arguments indicate.

The filter must be inside single quotes (‘).

<verbose> The level of verbosity as one of:

1 - print header of packets
2 - print header and data from IP of packets
3 - print header and data from Ethernet of packets
4 - print header of packets with interface name

<count> The number of packets the sniffer reads before stopping. If you don't put a
number here, the sniffer will run until you stop it with <CTRL+C>.

<tsformat> The format of timestamp.
l a: absolute UTC time, yyyy-mm-dd hh:mm:ss.ms
l l: absolute LOCAL time, yyyy-mm-dd hh:mm:ss.ms
l otherwise: relative to the start of sniffing, ss.ms

For a simple sniffing example, enter the CLI command diagnose sniffer packet port1 none 1 3.
This displays the next three packets on the port1 interface using no filtering, and verbose level 1. At this verbosity
level, you can see the source IP and port, the destination IP and port, action (such as ack), and sequence
numbers.

In the output below, port 443 indicates these are HTTPS packets and that 172.20.120.17 is both sending and
receiving traffic.

Head_Office_620b # diagnose sniffer packet port1 none 1 3
interfaces=[port1]
filters=[none]

0.545306 172.20.120.17.52989 -> 172.20.120.141.443: psh 3177924955 ack 1854307757

0.545963 172.20.120.141.443 -> 172.20.120.17.52989: psh 1854307757 ack 3177925808

0.562409 172.20.120.17.52988 -> 172.20.120.141.443: psh 4225311614 ack 3314279933
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For a more advanced example of packet sniffing, the following commands will report packets on any interface
that are traveling between a computer with the host name of “PC1” and a computer with the host name of “PC2”.
With verbosity 4 and above, the sniffer trace displays the interface names where traffic enters or leaves the
FortiGate unit. Remember to stop the sniffer, type CTRL+C.

FGT# diagnose sniffer packet any "host <PC1> or host <PC2>" 4

or

FGT# diagnose sniffer packet any "(host <PC1> or host <PC2>) and icmp" 4

The following CLI command for a sniffer includes the ARP protocol in the filter which may be useful to
troubleshoot a failure in the ARP resolution (for example, PC2 may be down and not responding to the FortiGate
ARP requests).

FGT# diagnose sniffer packet any "host <PC1> or host <PC2> or arp" 4

How do you use packet capture

To use packet capture, the FortiGate must have a disk. You can enable the capture-packet in the firewall
policy, using the following CLI commands:

config firewall policy
edit <id>
set capture-packet enable

end

To configure packet capture filters, go to Network > Packet Capture.

When you add a packet capture filter, enter the following information and select OK.

Interface Select the interface to sniff from the drop-down menu.

You must select one interface. You can't change the interface without
deleting the filter and creating a new one, unlike the other fields.

Max Packets to Save

Enter the number of packets to capture before the filter stops.

This number can't be zero. You can halt the capturing before this number is
reached.

Enable Filters Select this option to specify filter fields

Host(s)

Enter the IP address of one or more hosts

Separate multiple hosts with commas. To enter a range, use a dash
without spaces, for example 172.16.1.5-172.16.1.15, or enter a subnet.

Port(s) Enter one or more ports to capture on the selected interface.

Separate multiple ports with commas. To enter a range, use a dash without
spaces, for example 88-90
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VLAN(s)
Enter one or more VLANs (if any).

Separate multiple VLANs with commas.

Protocol Enter one or more protocols. Separate multiple protocols with commas. To
enter a range, use a dash without spaces, for example 1-6, 17, 21-25.

Include IPv6 Packets Select this option if you're troubleshooting IPv6 networking, or if your
network uses IPv6. Otherwise, leave it disabled.

Include Non-IP Packets The protocols in the list are all IP based except for ICMP (ping). To capture
non-IP based packets, select this feature. Examples of non-IP packets
include IPsec, IGMP, ARP, and ICMP.

If you select a filter, you have the option to start and stop packet capture in the edit window, or download the
captured packets. You can also see the filter status and the number of packets captured.

You can select the filter and start capturing packets. When the filter is running, the number of captured packets
increases until it reaches theMax Packet Count or you stop it. When the filter is running, you can't download the
output file.

When the packet capture is complete, you can download the *.pcap file. You must use a third party application,
such asWireshark, to read *,pcap files. This tool provides you with extensive analytics and the full contents of the
packets that were captured.

To start, stop, or resume packet capture, use the symbols on the screen. These symbols are the same as those
used for audio or video playback. Hover over the symbol to reveal explanatory text. Similarly, to download the
*.pcap file, use the download symbol on the screen.

For more information on troubleshooting with packet capture and packet sniffing, see "Packet sniffing and packet
capture" on page 3279.

How to debug the packet flow
Traffic should come in and leave the FortiGate. If you determine that network traffic isn't entering and leaving the
FortiGate as expected, debug the packet flow.

You can only perform debugging using CLI commands. Debugging the packet flow requires that you enter a
number of debug commands as each one configures part of the debug action, with the final command starting
the debug.

If your FortiGate has FortiASIC NP4 or NP6 interface pairs that are offloading traffic,
this changes the packet flow. Before you perform the debug on any NP4 or NP6
interfaces, you should disable offloading on those interfaces. Enter diagnose npu
<interface pair> fastpath disable, where <interface pair> can be
np4, np6, np4lite, or np6lite.

The following configuration assumes that PC1 is connected to the internal interface of the FortiGate and has an
IP address of 10.11.101.200. PC1 is the host name of the computer.

To debug the packet flow in the CLI, enter the following commands:

FGT# diagnose debug disable
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FGT# diagnose debug flow filter add <PC1>
FGT# diagnose debug flow show console enable
FGT# diagnose debug flow show function-name enable
FGT# diagnose debug flow trace start 100
FGT# diagnose debug enable

The start 100 argument in the above list of commands limits the output to 100 packets from the flow. This is
useful to look at the flow without flooding your log or displaying too much information.

To stop all other debug activities, enter the command:

FGT# diagnose debug flow trace stop

The following is an example of debug flow output for traffic that has no matching security policy, and is in turn
blocked by the FortiGate unit. The denied message indicates that the traffic was blocked.

id=20085 trace_id=319 func=resolve_ip_tuple_fast line=2825 msg="vd-root received a packet
(proto=6, 192.168.129.136:2854->192.168.96.153:1863) from port3."

id=20085 trace_id=319 func=resolve_ip_tuple line=2924 msg="allocate a new session-
013004ac"

id=20085 trace_id=319 func=vf_ip4_route_input line=1597 msg="find a route: gw-
192.168.150.129 via port1"

id=20085 trace_id=319 func=fw_forward_handler line=248 msg=" Denied by forward policy
check"

Troubleshooting resources

Fortinet provides customers with resources of valuable information about FortiOS technical issues, including:

Technical documentation
Installation, Administration, and Quick Start Guides, as well as other technical documents, are available online at
the Fortinet Document Library: https://docs.fortinet.com

Fortinet video library
The Fortinet Video Library hosts a collection of video which provide valuable information about Fortinet products.

https://video.fortinet.com

Release notes
Issues that arise after the technical documentation is published will often be listed in the Release Notes. To find
these, go to the Fortinet Document Library.

Knowledge base
The Fortinet Knowledge Base provides access to a variety of articles, white papers, and other documentation that
provides technical insight into a range of Fortinet products. The Knowledge Base is available online at:
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http://kb.fortinet.com

Fortinet technical discussion forums
An online technical forum allows administrators to contribute to discussions about issues that relate to their
Fortinet products. Searching the forum can help an administrator identify if an issue has been experienced by
another user. You can access the support forums at: https://forum.fortinet.com/

Fortinet training services online campus
The Fortinet Training Services Online Campus hosts a collection of tutorials and training materials which you can
use to increase your knowledge of the Fortinet products. https://www.fortinet.com/training.html

Fortinet customer support
You defined your problem, researched a solution, put together a plan to find the solution, and executed that plan.
At this point, if the problem hasn't been solved, it's time to contact Fortinet Customer Service & Support for
assistance. Prepare yourself by reading How to work with Fortinet Support on Fortinet's Cookbook site.

https://support.fortinet.com
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Chapter 32 - Virtual Domains

Virtual domains

This guide explains how to set up and use Virtual Domains (VDOMs) with a FortiGate. It contains the following
sections:

l Virtual Domains Overview: information about the basic concepts and rules for using VDOMs.
l VDOMs in NAT mode: detailed explanations and examples for configuring VDOM features for a FortiGate in NAT

mode.
l VDOMs in transparent modedetailed explanations and examples for configuring VDOM features for a FortiGate in

Transparent mode.
l Inter-VDOM routing: concepts and scenarios for inter-VDOM routing.
l Troubleshooting Virtual Domains: diagnostic and troubleshooting information for some potential VDOM issues.

Before you begin using this guide, take a moment to note the following:

l By default, most FortiGate units support 10 VDOMs. Many FortiGate models
support purchasing a license key to increase the maximum number

l This guide uses a FortiGate unit with interfaces named port1 through port4 for
examples and procedures. The interface names on some models will vary.
Where possible aliases for these ports are indicated to show their intended
purpose and to help you determine which ports to use if your ports are labelled
differently.

l Administrators are assumed to be super_admin administrators unless
otherwise specified. Some restrictions will apply to other administrators.

What's new in FortiOS 5.6

The following new features have been added for Virtual Domains (VDOMs) in FortiOS 5.6:

VDOMs (5.6.3)
This section describes new VDOM features added to FortiOS 5.6.3.
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Rewrite Global Resources Page and VDOM edit page (444478)

The previous Global Resources and VDOM edit pages were outdated. These pages have been redesigned and
updated to use modern styling.

l Updated api/v2/monitor/system/vdom-resources to include VDOM resource usage
l Created new endpoint api/v2/monitor/system/global-resources for retrieving global resource usage across VDOMs
l Rewrote VDOM create/edit page in Angular
l Rewrote Global Resources page in Angular

VDOMs (5.6)
This section describes new VDOM features added to FortiOS 5.6

Dashboard changes

The option to enable VDOMs is no longer part of the System Information widget. To enable VDOMs, you must
now go to System > Settings.

Firewall Service Cache improvement

The Firewall Service Cache will now have separate caches for each VDOM, to improve the speed of cache
searches.
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Virtual domains (VDOMs) are a method of dividing a FortiGate device into two or more virtual instances that
function as multiple independent devices. VDOMs can provide separate firewall policies and, in NAT mode,
completely separate configurations for routing and VPN services for each connected network or organization.

This chapter will cover the basics of VDOMs, how they change your FortiGate device, and how to work with
VDOMs.

This section includes:

l Benefits of VDOMs
l Enabling and accessing VDOMs
l Configuring VDOMs

Multiple VDOM support isn't available when Security Fabric is enabled.

Benefits of VDOMs
VDOMs provide the following benefits:

l Easier administration
l Continued security
l Savings in physical space and power
l Improving transparent mode configuration
l More flexible MSSP configurations

Easier administration

VDOMs provide separate security domains that allow separate zones, user authentication, firewall policies,
routing, and VPN configurations. VDOMs separate security domains and simplify administration of complex
configurations—you do not have to manage as many settings at one time.

By default, each FortiGate unit has a VDOM named root. This VDOM includes all of the unit’s physical interfaces,
modem, VLAN subinterfaces, zones, firewall policies, routing settings, and VPN settings.

Also, you can optionally assign an administrator account restricted to one VDOM. If the VDOM is created to serve
an organization, this feature enables the organization to manage its own configuration.

In order to connect to a VDOM, an admin must log in using an interface belonging to that VDOM. This allows for
proper authentication and restricts that admin's access to a single VDOM.

Each physical FortiGate unit requires a FortiGuard license to access security updates. VDOMs do not require any
additional FortiGuard licenses, or updating — all the security updates for all the VDOMs are performed once per
update at the global level. Combined this can be a potentially large money and time saving feature in your
network.
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Management systems such as SNMP, logging, alert email, FDN-based updates, and NTP-based time setting use
addresses and routing in the management VDOM to communicate with the network. They can connect only to
network resources that communicate with the management VDOM. Using a separate VDOM for management
traffic enables easier management of the FortiGate unit global settings, and VDOM administrators can also
manage their VDOMsmore easily.

Continued security

When a packet enters a VDOM, it is confined to that VDOM and is subject to any firewall policies for connections
between VLAN subinterfaces or zones in that VDOM, just like those interfaces on a FortiGate unit without
VDOMs enabled.

To travel between VDOMs, a packet must first pass through a firewall policy on a physical interface. The packet
then arrives at another VDOM on that same FortiGate unit, but on a different interface, where it must pass
through another firewall before entering. It doesn’t matter if the interface is physical or virtual — inter-VDOM
packets still require the same security measures as when passing through physical interfaces.

VDOMs provide an additional level of security because regular administrator accounts are specific to one VDOM
— an administrator restricted to one VDOM cannot change information on other VDOMs. Any configuration
changes and potential errors will apply only to that VDOM and limit any potential down time. Using this concept,
you can farther split settings so that the management domain is only accessible by the super_admin and does not
share any settings with the other VDOMs.

Savings in physical space and power

To increase the number of physical FortiGate units, you need more rack space, cables, and power to install the
new units. You also need to change your network configuration to accommodate the new physical units. In the
future, if you need fewer physical units you are left with expensive hardware that is idle.

Increasing VDOMs involves no additional hardware, no additional cabling, and very few changes to existing
networking configurations. VDOMs save physical space and power. You are limited only by the size of the VDOM
license you buy and the physical resources on the FortiGate unit.

For example, if you are using one FortiGate 620B unit with 10 VDOMs instead of 10 physical units, over a year
you will save an estimated 18,000 kWh. You could potentially save ten times that amount with a 100 VDOM
license.

By default, most FortiGate units support 10 VDOMs. Many FortiGate models support purchasing a license key to
increase the maximum number.

Improving transparent mode configuration

When VDOMs are not enabled and you put your FortiGate unit into transparent mode, all the interfaces on your
unit become broadcast interfaces. The problem with this is that there are no interfaces free to do anything else.

With multiple VDOMs you can have one of them configured in transparent mode, and the rest in NAT mode. In
this configuration, you have an available transparent mode FortiGate unit you can drop into your network for
troubleshooting, and you also have the standard NAT for networking.

More flexible MSSP configurations

If you are a managed security and service provider (MSSP), VDOMs are fundamental to your business. As a
service provider you have multiple customers, each with their own needs and service plans. VDOMs allow you to
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have a separate configuration for each customer, or group of customers; with up to 500 VDOMs configured per
FortiGate unit on high end models.

Not only does this provide the exact level of service needed by each customer, but administration of the FortiGate
unit is easier as well - you can provide uninterrupted service generally with immediate changes as required. Most
importantly, it allows you to only use the resources that each customer needs. Inter-VDOM links allow you to
customize the level of interaction you need between each of your customers and your administrators.

Enabling and accessing VDOMs
While VDOMs are essentially the same as your regular FortiGate unit for menu configuration, CLI command
structure, and general task flow, there are some small differences.

After first enabling VDOMs on your FortiGate unit, you should take the time to familiarize yourself with the
interface. This section will help walk you through virtual domains.

This section includes:

l Enabling VDOMs
l Viewing the VDOM list
l Global and per-VDOM settings
l Resource settings
l VDOM Licensing
l Logging in to VDOMs

Enabling VDOMs

Using the default admin administration account, you can enable or disable VDOM operation on the FortiGate
unit.

To enable VDOM configuration - GUI:

1. Log in with a super_admin account.
2. Go to System > Settings.
3. UnderOperations Settings, enable Virtual Domains.
The FortiGate unit logs off all sessions. You can now log in again as admin.

To enable VDOM configuration - CLI:

config system global
set vdom-admin enable

end

Changes to the GUI and CLI

When Virtual Domains are enabled, your FortiGate unit will change. The changes will be visible in both the GUI
and CLI, just the GUI, or just the CLI.

When enabling VDOMs, the GUI and the CLI are changed as follows:

l Global and per-VDOM configurations are separated. This is indicated in the Online Help by Global and VDOM
icons.

l Only admin accounts using the super_admin profiles can view or configure global options
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l Admin accounts using the super_admin profile can configure all VDOM configurations.
l All other administrator accounts can configure only the VDOM to which they are assigned.

The following changes are specific to the GUI:

l In the Global view, the System section of the left-hand menu is renamed to Global, and includes a VDOM sub-
menu.

l The Log Config menu is moved from Log & Report into the new Global section.
l For admin accounts using the super_admin profile, a new section called Virtual Domains is added at the bottom of

the left-hand menu. It lists all the individual VDOMs as expandable menus, with all VDOM specific options in that
menu, which allows you to easily select which VDOM to configure, including the root VDOM.

In the CLI, admin accounts using the super_admin profile must specify either the global or a VDOM-specific shell
before entering commands:

l To change FortiGate unit system settings, from the top level you must first enter the following CLI before entering
commands:

config global

l To change VDOM settings, from the top level you must first enter the following CLI before entering commands for
that VDOM:

config vdom
edit <vdom_name>

Settings configured outside of a VDOM are called global settings. These settings affect the entire FortiGate unit
and include areas such as interfaces, HA, maintenance, some antivirus settings, and some logging settings. In
general, any unit settings that should only be changed by the top level administrator are global settings.

Settings configured configwithin a VDOM are called VDOM settings. These settings affect only that specific
VDOM and include areas such as operating mode, routing, firewall, VPN, some antivirus, some logging, and
reporting.

Viewing the VDOM list

The VDOM list shows all virtual domains, their status, and which VDOM is the management VDOM. It is
accessible if you are logged in on an administrator account with the super_admin profile such as the “admin”
administrator account.

In the VDOM list you can create or delete VDOMs, edit VDOMs, change the management VDOM, and enable or
disable VDOMs.

You can access the VDOM list when viewing by going toGlobal > System > VDOM.

The root domain cannot be disabled, even if it is not the management VDOM.

Global and per-VDOM settings

Settings configured outside of a VDOM are called global settings. These settings affect the entire FortiGate unit
and include areas such as interfaces, HA, maintenance, some antivirus, and some logging. In general, any unit
settings that should only be changed by the top level administrator are global settings.
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Settings configured within a VDOM are called VDOM settings. These settings affect only that specific VDOM and
include areas such as operating mode, routing, firewall, VPN, some antivirus, some logging settings, and
reporting.

When Virtual Domains are not enabled, the entire FortiGate unit is effectively a single VDOM. Per-VDOM limits
apply. For some resource types, the global limit cannot be reached with only one VDOM.

Resource settings

Your FortiGate unit has a limited amount of hardware resources such as memory, disk storage, CPU operations.
When Virtual Domains are disabled, this limit is not a major concern because all sessions, users, and other
processes share all the resources equally.

When using Virtual Domains, hardware resources can be divided differently between Virtual Domains as they are
needed. Minimum levels of resources can be specified for each VDOM, so that no Virtual Domain will suffer a
complete lack of resources.

For example, if one VDOM has only a web server and logging server connected, and a second VDOM has an
internal network of 20 users, these two VDOMs will require different levels of resources. The first VDOM will
require many sessions but no user accounts. This compares to the second VDOM where user accounts and
management resources are required, but fewer sessions.

Using the global and per-VDOM resource settings, you can customize the resources allocated to each VDOM to
ensure the proper level of service is maintained on each VDOM.

Global resource settings

Global Resources apply to the whole FortiGate unit. They represent all of the hardware capabilities of your unit.
By default the values are set to their maximum values. These values vary by your model due to each model
having differing hardware capabilities.

It can be useful to change the maximum values for some resources to ensure there is enough memory available
for other resources that may be more important to your configuration.

To use the earlier example, if your FortiGate unit is protecting a number of web servers and other publicly
accessible servers you would want to maximize the available sessions and proxies while minimizing other settings
that are unused such as user settings, VPNs, and dial-up tunnels.

Global Resources are only configurable at the global level, and only the admin account has access to these
settings. To view the resource list, go toGlobal > System > Global Resources. You can also use the following
CLI command:

config global
config system resource-limits
get

Note that global resources, such as the log disk quota resource, will only be visible if your FortiGate unit hardware
supports those resources, such as having a hard disk to support the log disk resource.
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For explicit proxies, when configuring limits on the number of concurrent users, you
need to allow for the number of users based on their authentication method.
Otherwise you may run out of user resources prematurely.

Each session-based authenticated user is counted as a single user using their
authentication membership (RADIUS, LDAP, FSAE, local database etc.) to match
users in other sessions. So one authenticated user in multiple sessions is still one
user.

For all other situations, the source IP address is used to determine a user. All sessions
from a single source address are assumed to be from the same user.

Per-VDOM resource settings

While Global resources apply to resources shared by the whole FortiGate unit, per-VDOM resources are specific
to only one Virtual Domain.

By default all the per-VDOM resource settings are set to no limits. This means that any single VDOM can use up
all the resources of the entire FortiGate unit if it needs to do so. This would starve the other VDOMs for resources
to the point where they would be unable to function. For this reason, it is recommended that you set some
maximums on resources that are most vital to your customers.

Each Virtual Domain has its own resource settings. These settings include both maximum, and minimum levels.
The maximum level is the highest amount of that resource that this VDOM can use if it is available on the
FortiGate unit. Minimum levels are a guaranteed level that this minimum level of the resource will always be
available no matter what the other VDOMsmay be using.

For example, consider a FortiGate unit that has ten VDOMs configured. vdom1 has a maximum of 5000 sessions
and a minimum of 1000 sessions. If the FortiGate unit has a global maximum of 20,000 sessions, it is possible
that vdom1 will not be able to reach its 5000 session upper limit. However, at all times vdom1 is guaranteed to
have 1000 sessions available that it can use. On the other hand, if the remaining nine VDOMs use only 1000
sessions each, vdom1 will be able to reach its maximum of 5000.

To view per-VDOM resource settings - GUI:

1. Select Global > System > VDOM.
2. Select the root VDOM, and select Edit.
3. Adjust the settings in the Resource Usage section of the page.
4. Select OK.

To view per-VDOM resource settings - CLI:

config global
config system vdom-property

edit root
get

VDOM Licensing

For select FortiGate models in the 1U category and higher, you can purchase a license key to increase the
maximum number of VDOMs. Most Enterprise and Large Enterprise (2U) models can support up to 500 VDOMs.
Chassis-based models can support over 500 VDOMs. For specific information, see the product data sheet.
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Configuring 500 or more VDOMs will result in reduced system performance. See Troubleshooting Virtual
Domains.

Your FortiGate unit has limited resources that are divided among all configured
VDOMs. These resources include system memory and CPU. Running security
features on many VDOMs at once can limit resources available for basic processing. If
you require many VDOMs, all with active security features, it is recommended to
upgrade to a more powerful FortiGate unit.

It is important to backup your configuration before upgrading the VDOM license on
your FortiGate unit or units, especially with FortiGate units in HAmode.

To obtain a VDOM license key

1. Log in with a super_admin account.
2. Go to the Dashboard.
3. Record your FortiGate unit serial number as shown in System Information widget.
4. In the License Information widget, locate Virtual Domain and select Purchase More.

If you do not see the Purchase More option on the System Dashboard, your
FortiGate model does not support more than 10 VDOMs.

5. You will be taken to the Fortinet customer support website where you can log in and purchase a license key for 25,
50, 100, 250, 500, or more VDOMs.

6. When you receive your license key, go to the Dashboard and select Upload License under License
Information, Virtual Domains.

7. In the Input License Key field, enter the 32-character license key you received from Fortinet customer support.
8. Select Apply.
To verify the new VDOM license, in global configuration go to System > Dashboard. Under License
Information, Virtual Domains the maximum number of VDOMs allowed is shown.

VDOMs created on a registered FortiGate unit are recognized as real devices by any
connected FortiAnalyzer unit. The FortiAnalyzer unit includes VDOMs in its total
number of registered devices. For example, if three FortiGate units are registered on
the FortiAnalyzer unit and they contain a total of four VDOMs, the total number of
registered FortiGate units on the FortiAnalyzer unit is seven. For more information,
see the FortiAnalyzer Administration GUIde.

Logging in to VDOMs

Management services communicate using the management VDOM, which is the root VDOM by default.
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Management traffic requires an interface that has access to the Internet. If there is no
interface assigned to the VDOM containing the management traffic, services including
updates will not function.

Accessing a VDOM if you are the FortiGate's Administrator - GUI:

1. Log in with a super_admin account.
2. In the Virtual Domainsmenu on the left-hand side, select the VDOM to configure.

The menu will expand to show the various pages and settings for that VDOM.
3. When you have finished configuring the VDOM, you can

l open theGlobal menu to return to global configuration
l log out

Accessing a VDOM if you are the FortiGate's Administrator - CLI:

With the super_admin, logging into the CLI involves also logging into the specific VDOM. If you need a reminder,
use edit ? to see a list of existing VDOMs before you editing a VDOM.

If you misspell a VDOM you are trying to switch to, you will create a new VDOM by that
name. Any changes you make will be part of the new VDOM, and not the intended
VDOM. If you are having problems where your changes aren’t visible, back up to the
top level and use edit ? to see a list of VDOMs to ensure this has not happened. If it
has happened, see Enabling and accessing VDOMs.

config vdom
edit ?
edit <chosen_vdom>

..
<enter vdom related commands>
..

end
exit

Accessing a VDOM if you are the VDOM's Administrator - GUI:

1. Connect to the FortiGate unit using an interface that belongs to the VDOM to be configured.
2. Log in using an administrator account that has access to the VDOM.

The main GUI page opens. The interface is largely the same as if the device has VDOMs disabled. From here you
can access VDOM-specific settings.

Accessing a VDOM if you are the VDOM's Administrator - CLI:

A non-super_admin account has access to only one VDOM and must log in through an interface that belongs to
the same VDOM, but the process is the same as logging into a non-VDOM unit.

Login: regular_admin
Password: <password>
..
<enter vdom related commands>
..
exit
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Configuring VDOMs
Only a super admin administrator account such as the default admin account can create, disable, or delete
VDOMs. That account can create additional administrators for each VDOM.

This section includes:

l Creating a VDOM
l Disabling a VDOM
l Deleting a VDOM
l Administrators in VDOMs
l Changing the management VDOM

Creating a VDOM

Once you have enabled VDOMs on your FortiGate unit, you can create additional VDOMs beyond the default root
Virtual Domain.

By default, new VDOMs are set to NAT mode. If you want a Virtual Domain to be in transparent mode, you must
manually change it.

You can name new VDOM as you like with the following restrictions:

l only letters, numbers, “-”, and “_” are allowed
l no more than 11 characters are allowed
l no spaces are allowed
l VDOMs cannot have the same names as interfaces, zones, switch interfaces, or other VDOMs.

When creating large numbers of VDOMs you should not enable advanced features
such as proxies, web filtering, and antivirus due to limited FortiGate unit resources.
Also when creating large numbers of VDOMs, you may experience reduced
performance for the same reason.

To create a VDOM - GUI:

1. Log in with a super_admin account.
2. Select Global > System > VDOM.
3. Select Create New.
4. Enter a unique name for your new VDOM.
5. Enter a short and descriptive comment to identify this VDOM.
6. Select OK.
Repeat Steps 3 through 6 to add additional VDOMs.

To create a VDOM - CLI:

config vdom
edit <new_vdom_name>

end
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If you want to edit an existing Virtual Domain in the CLI, and mistype the name a new
Virtual Domain will be created with this new misspelled name. If you notice expected
configuration changes are not visible, this may be the reason. You should periodically
check your VDOM list to ensure there are none of these misspelled VDOMs present.

Disabling a VDOM

The status of a VDOM can be Enabled or Disabled.

Active status VDOMs can be configured. Active is the default status when a VDOM is created. The management
VDOM must be an Active VDOM.

Disabled status VDOMs are considered “offline”. The configuration remains, but you cannot use the VDOM, and
only the super_admin administrator can view it. You cannot delete a disabled VDOM without first enabling it, and
removing references to it like usual—there is no Delete icon for disabled status VDOMs. You can assign
interfaces to a disabled VDOM.

The following procedures show how to disable a VDOM called “test-vdom”.

To disable a VDOM - GUI:

1. Go toGlobal > System > VDOM.
2. Open the VDOM for editing.
3. Ensure Enable is not selected and then select OK.

The VDOM’s Enable icon in the VDOM list is a grey X.

To disable a VDOM - CLI:

config vdom
edit test-vdom

config system settings
set status disable

end
end

To enable a VDOM - GUI:

1. Go toGlobal > System > VDOM.
2. Open the VDOM for editing.
3. Ensure Enable is selected and then select OK.

The VDOM’s Enable icon in the VDOM list is a green checkmark.

To enable a VDOM - CLI:

config vdom
edit test-vdom

config system settings
set status enable

end
end

Deleting a VDOM

Deleting a VDOM removes it from the FortiGate unit configuration.
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Before you can delete a VDOM, all references to it must be removed, including any per-VDOM objects. If there
are any references to the VDOM remaining, you will see an error message and not be able to delete the VDOM.

A disabled VDOM cannot be deleted. You can also not delete the root VDOM or the management VDOM.

Before deleting a VDOM, a good practice is to reset any interface referencing that
VDOM to its default configuration, with “root” selected as the Virtual Domain.

The following procedures show how to delete the test-vdom VDOM.

To delete a VDOM - GUI:

1. Go toGlobal > System > VDOM.
2. Select the check box for the VDOM and then select the Delete icon.

If the Delete icon is not active, there are still references to the VDOM that must first be removed. The Delete icon
is available when all the references to this VDOM are removed.

3. Confirm the deletion.

To delete a VDOM - CLI:

config vdom
delete test-vdom

end

Removing references to a VDOM

When you are going to delete a VDOM, all references to that VDOM must first be removed. It can be difficult to
find all the references to the VDOM. This section provides a list of common objects that must be removed before
a VDOM can be deleted, and a CLI command to help list the dependencies.

Interfaces are an important part of VDOMs. If you can move all the interfaces out of a VDOM, generally you will
be able to delete that VDOM.

Common objects that refer to VDOMs

When you are getting ready to delete a VDOM check for, and remove the following objects that refer to that
VDOM or its components:

l Routing - both static and dynamic routes
l Firewall addresses, policies, groups, or other settings
l Security Features/Profiles
l VPN configuration
l Users or user groups
l Logging
l DHCP servers
l Network interfaces, zones, custom DNS servers
l VDOM Administrators
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Administrators in VDOMs

When VDOMs are enabled, permissions change for administrators. Administrators are now divided into per-
VDOM administrators, and super_admin administrators. Only super_admin administrator accounts can
create other administrator accounts and assign them to a VDOM.

Administrator VDOM permissions

Different types of administrator accounts have different permissions within VDOMs. For example, if you are using
a super_admin profile account, you can perform all tasks. However, if you are using a regular admin account, the
tasks available to you depend on whether you have read only or read/write permissions. The following table
shows what tasks can be performed by which administrators.

Administrator VDOM permissions

Tasks
Regular administrator account

Super_admin profile
administrator accountRead only

permission
Read/write
permission

View global settings yes yes yes

Configure global settings no no yes

Create or delete VDOMs no no yes

Configure multiple VDOMs no no yes

Assign interfaces to a
VDOM

no no yes

Revision Control Backup
and Restore no no yes

Create VLANs no yes - for 1 VDOM yes - for all VDOMs

Assign an administrator to
a VDOM no no yes

Create additional admin
accounts

no yes - for 1 VDOM yes - for all VDOMs

Create and edit protection
profiles no yes - for 1 VDOM yes - for all VDOMs

The only difference in admin accounts when VDOMs are enabled is selecting which VDOM the admin account
belongs to. Otherwise, by default the administration accounts are the same as when VDOMs are disabled and
closely resemble the super_admin account in their privileges.
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Creating administrators for VDOMs

Using the admin administrator account, you can create additional administrator accounts and assign them to
VDOMs.

The newly-created administrator can access the FortiGate unit only through network
interfaces that belong to their assigned VDOM or through the console interface. The
network interface must be configured to allow management access, such as HTTPS
and SSH. Without these in place, the new administrator will not be able to access the
FortiGate unit and will have to contact the super_admin administrator for access.

The following procedure creates a new Local administrator account called admin_sales with a password of
fortinet in the sales VDOM using the admin_prof default profile.

To create an administrator for a VDOM - GUI:

1. Log in with a super_admin account.
2. Go to System > Administrators.
3. Select Create New.
4. Select Regular for Type, as you are creating a Local administrator account.
5. Enter the necessary information about the administrator: email, password, etc.
6. If this admin will be accessing the VDOM from a particular IP address or subnet, enable Restrict this Admin

Login from Trusted Hosts Only and enter the IP in Trusted Host #1.
7. Select prof_admin for the Admin Profile.
8. Select sales from the list of Virtual Domains.
9. Select OK.

To create administrators for VDOMs - CLI:

config global
config system admin

edit <new_admin_name>
set vdom <vdom_for_this_account>
set password <pwd>
set accprofile <an_admin_profile>
...

end

Virtual Domain administrator dashboard display

When administrators logs into their virtual domain, they see a different dashboard than the global administrator
will see. The VDOM dashboard displays information only relevant to that VDOM — no global or other VDOM
information is displayed.
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VDOM dashboard information

Information per-VDOM Global

System Information read-only yes

License Information no yes

CLI console yes yes

Unit Operation read-only yes

Alert Message Console no yes

Top Sessions limited to VDOM sessions yes

Traffic limited to VDOM interfaces yes

Statistics yes yes

Changing the management VDOM

The management virtual domain is the virtual domain where all the management traffic for the FortiGate unit
originates. This management traffic needs access to remote servers, such as FortiGuard services and NTP, to
perform its duties. It needs access to the Internet to send and receive this traffic.

Management traffic includes, but is not limited to

l DNS lookups
l logging to FortiAnalyzer or syslog
l FortiGuard service
l sending alert emails
l Network time protocol traffic (NTP)
l Sending SNMP traps
l Quarantining suspicious files and email.

By default the management VDOM is the root domain. When other VDOMs are configured on your FortiGate
unit, management traffic can be moved to one of these other VDOMs.

Reasons to move the management VDOM include selecting a non-root VDOM to be your administration VDOM,
or the root VDOM not having an interface with a connection to the Internet.

You cannot change the management VDOM if any administrators are using RADIUS
authentication.

The following procedure will change the management VDOM from the default root to a VDOM named mgmt_
vdom. It is assumed that mgmt_vdom has already been created and has an interface that can access the
Internet.
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To change the management VDOM - GUI:

1. Select Global > System > VDOM.
2. Select the checkbox next to the required VDOM.
3. Select Switch Management.

The current management VDOM is shown in square brackets, “[root]” for example.

To change the management VDOM - CLI:

config global
config system global

set management-vdom mgmt_vdom
end

Management traffic will now originate from mgmt_vdom.
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VDOMs in NAT mode

A new VDOM uses network address translation (NAT) mode by default. In this mode, you install the VDOM is as a
gateway or router between two networks. In most cases, the VDOM is between a private network and the
Internet.

VDOMs on the same FortiGate to use either NAT or transparent mode, regardless of the operation mode of other
VDOMs on that FortiGate. For more information about Transparent mode, see "VDOMs in transparent mode" on
page 3353.

This chapter contains the following sections:

l Using a VDOM in NAT mode
l Example configuration: VDOM in NAT mode

Using a VDOM in NAT mode
When using a VDOM in NAT mode,

l Using a VDOM in NAT mode
l Configuring interfaces
l Configuring VDOM routing
l Configuring security policies
l Changing the inspection mode
l Configuring security profiles
l Configuring VPNs for a VDOM
l Certificate management

Configuring interfaces

A VDOM must contain at least two interfaces to be useful. These can be physical interfaces or VLAN interfaces.
By default, all physical interfaces are in the root VDOM. When you create a new VLAN, it is in the root VDOM by
default.

When there are VDOMs on the FortiGate unit in both NAT and Transparent operation modes, some interface
fields will be displayed as “-” on Network > Interfaces. Only someone with a super_admin account can view all
the VDOMs.

When moving an interface to a different VDOM, firewall IP pools and virtual IPs for this
interface are deleted. You should manually delete any routes that refer to this
interface. Once the interface has been moved to the new VDOM, you can add these
services to the interface again.

When configuring VDOMs on FortiGate units with accelerated interfaces you must
assign both interfaces in the pair to the same VDOM for those interfaces to retain their
acceleration. Otherwise they will become normal interfaces.
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This section includes the following topics:

l Adding a VLAN to a NAT VDOM
l Moving an interface to a VDOM
l Deleting an interface
l Adding a zone to a VDOM

Adding a VLAN to a NAT VDOM

The following example shows one way that multiple companies can maintain their security when they are using
one FortiGate unit with VLANs that share interfaces on the unit.

This procedure will add a VLAN interface called client1-v100 with a VLAN ID of 100 to an existing VDOM
called client1 using the physical interface called port2.

The physical interface does not need to belong to the VDOM that the VLAN belongs
to.

To add a VLAN subinterface to a VDOM - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select Create New.
3. Enter the following information and select OK:

Name client1-v100

Interface port2

VLAN ID 100

Virtual Domain Client1

Addressing mode Manual

IP/Netmask 172.20.120.110/255.255.255.0

Administrative Access HTTPS, SSH

You will see an expand arrow added to the port2 interface. When the arrow is expanded, the interface
shows the client1-v100 VLAN subinterface.

To add a VLAN subinterface to a VDOM - CLI:

config global
config system interface

edit client1-v100
set type vlan
set vlanid 100
set vdom Client1
set interface port2
set ip 172.20.120.110 255.255.255.0
set allowaccess https ssh
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end

Moving an interface to a VDOM

Interfaces belong to the root VDOM by default. Moving an interface is the same procedure no matter if its moving
from the root VDOM or a any other VDOM.

If you have an accelerated pair of physical interfaces both interfaces must be in the same VDOM or you will lose
their acceleration.

The following procedure will move the port3 interface to the Client2 VDOM. This is a common action when
configuring a VDOM. It is assumed that the Client2 VDOM has already been created. It is also assumed that your
FortiGate unit has a port3 interface. If you are using a different model, your physical interfaces may not be
named port2, external or port3.

To move an existing interface to a different VDOM - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select Edit for the port3 interface.
3. Select Client2 as the new Virtual Domain.
4. Select OK.

To move an existing interface to a different VDOM - CLI:

config global
config system interface

edit port3
set vdom Client2

end

Deleting an interface

Before you can delete a virtual interface, or move an interface from one VDOM to another, all references to that
interface must be removed. For a list of objects that can refer to an interface see Virtual Domains Overview.

The easiest way to be sure an interface can be deleted is when the Delete icon is no longer greyed out. If it
remains greyed out when an interface is selected, that interface still has objects referring to it, or it is a physical
interface that cannot be deleted.

To delete a virtual interface - GUI:

1. Ensure all objects referring to this interface have been removed.
2. Select Global > Network > Interfaces.
3. Select the interface to delete.
4. Select the delete icon.

Adding a zone to a VDOM

Grouping interfaces and VLAN subinterfaces into zones simplifies policy creation. You can configure policies for
connections to and from a zone, but not between interfaces in a zone.
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Zones are VDOM-specific. A zone cannot be moved to a different VDOM. Any interfaces in a zone cannot be
used in another zone. To move a zone to a new VDOM requires deleting the current zone and re-creating a zone
in the new VDOM.

The following procedure will create a zone called accounting in the client2 VDOM. It will not allow intra-
zone traffic, and both port3 and port2 interfaces belong to this zone. This is a method of grouping and
isolating traffic over particular interfaces—it is useful for added security and control within a larger network.

To add a zone to a VDOM - GUI:

1. In Virtual Domains, select the client2 VDOM.
2. Go to Network > Interfaces.
3. Select Create New > Zone.
4. Enter the following information and select OK:

Zone Name accounting

Block intra-zone traffic Select

Interface Members port3, port2

To add a zone to a VDOM - CLI:

config vdom
edit client2

config system zone
edit accounting

set interface port3 port2
set intrazone deny

end
end

Configuring VDOM routing

Routing is VDOM-specific. Each VDOM should have a default static route configured as a minimum. Within a
VDOM, routing is the same as routing on your FortiGate unit without VDOMs enabled.

When configuring dynamic routing on a VDOM, other VDOMs on the FortiGate unit can be neighbors. The
following topics give a brief introduction to the routing protocols, and show specific examples of how to configure
dynamic routing for VDOMs. Figures are included to show the FortiGate unit configuration after the successful
completion of the routing example.

Default static route for a VDOM

The routing you define applies only to network traffic entering non-ssl interfaces belonging to this VDOM. Set the
administrative distance high enough, typically 20, so that automatically configured routes will be preferred to the
default.

In the following procedure, it is assumed that a VDOM called “Client2” exists. The procedure will create a default
static route for this VDOM. The route has a destination IP of 0.0.0.0, on the port3 interface. It has a gateway of
10.10.10.1, and an administrative distance of 20.

The values used in this procedure are very standard, and this procedure should be part of configuring all VDOMs.
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To add a default static route for a VDOM - GUI:

1. In Virtual Domains, select the client2 VDOM.
2. Go to Network > Static Routes.
3. Select Create New.
4. Enter the following information and select OK:

Destination IP/Mask 0.0.0.0/0.0.0.0

Device port2

Gateway 10.10.10.1

Distance 20

To add a default static route for a VDOM - CLI:

config vdom
edit client2

config router static
edit 4

set device port2
set dst 0.0.0.0 0.0.0.0
set gateway 10.10.10.1
set distance 20

end
end

Dynamic Routing in VDOMs

Dynamic routing is VDOM-specific, like all other routing. Dynamic routing configuration is the same with VDOMs
as with your FortiGate unit without VDOMs enabled, once you are at the routing menu. If you have multiple
VDOMs configured, the dynamic routing configuration between them can become quite complex.

VDOMs provide some interesting changes to dynamic routing. Each VDOM can be a neighbor to the other
VDOMs. This is useful in simulating a dynamic routing area or AS or network using only your FortiGate unit.

You can separate different types of routing to different VDOMs if required. This allows for easier troubleshooting.
This is very useful if your FortiGate unit is on the border of a number of different routing domains.

For more information on dynamic routing in FortiOS, see the Advanced Routing handbook.

Inter-VDOM links must have IP addresses assigned to them if they are part of a dynamic routing configuration.
Inter-VDOM links may or may not have IP addresses assigned to them. Without IP addresses, you need to be
careful how you configure routing. While the default static route can be assigned an address of 0.0.0.0 and rely
instead on the interface, dynamic routing almost always requires an IP address.

RIP

The RIP dynamic routing protocol uses hop count to determine the best route, with a hop count of 1 being directly
attached to the interface and a hop count of 16 being unreachable. For example if two VDOMs on the same
FortiGate unit are RIP neighbors, they have a hop count of 1.
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OSPF

OSPF communicates the status of its network links to adjacent neighbor routers instead of the complete routing
table. When compared to RIP, OSPF is more suitable for large networks, it is not limited by hop count, and is
more complex to configure. For smaller OSPF configurations its easiest to just use the backbone area, instead of
multiple areas.

BGP

BGP is an Internet gateway protocol (IGP) used to connect autonomous systems (ASes) and is used by Internet
service providers (ISPs). BGP stores the full path, or path vector, to a destination and its attributes which aid in
proper routing.

Configuring security policies

Security policies are VDOM-specific. This means that all firewall settings for a VDOM, such as firewall addresses
and security policies, are configured within the VDOM.

In VDOMs, all firewall related objects are configured per-VDOM including addresses, service groups, security
profiles, schedules, traffic shaping, and so on. If you want firewall addresses, you will have to create them on
each VDOM separately. If you have many addresses, and VDOMs this can be tedious and time consuming.
Consider using a FortiManager unit to manage your VDOM configuration — it can get firewall objects from a
configured VDOM or FortiGate unit, and push those objects to many other VDOMs or FortiGate units.

You can customize the Policy display by including some or all columns, and
customize the column order onscreen. Due to this feature, security policy screenshots
may not appear the same as on your screen.

Configuring a security policy for a VDOM

Your security policies can involve only the interfaces, zones, and firewall addresses that are part of the current
VDOM, and they are only visible when you are viewing the current VDOM. The security policies of this VDOM
filter the network traffic on the interfaces and VLAN subinterfaces in this VDOM.

A firewall service group can be configured to group multiple services into one service group. When a descriptive
name is used, service groups make it easier for an administrator to quickly determine what services are allowed
by a security policy.

In the following procedure, it is assumed that a VDOM called Client2 exists. The procedure will configure an
outgoing security policy. The security policy will allow all HTTPS, SSH, and DNS traffic for the SalesLocal
address group on VLAN_200 going to all addresses on port3. This traffic will be scanned and logged.

To configure a security policy for a VDOM - GUI:

1. In Virtual Domains, select the client2 VDOM.
2. Go to Policy & Objects > IPv4 Policy.
3. Select Create New.
4. Enter the following information and select OK:
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Name Client2-outgoing

Incoming Interface VLAN_200

Outgoing Interface port3

Source Address SalesLocal

Destination Address any

Schedule always

Service HTTPS, SSH, DNS

Action ACCEPT

Log Allowed Traffic enable

To configure a security policy for a VDOM - CLI:

config vdom
edit Client2

config firewall policy
edit 12

set srcintf VLAN_200
set srcaddr SalesLocal
set dstintf port3(dmz)
set dstaddr any
set schedule always
set service HTTPS SSH
set action accept
set status enable
set logtraffic enable

end
end

Changing the inspection mode

If you wish to change the inspection mode for a VDOM, go to System > VDOM and edit the VDOM you want to
configure. Set Inspection Mode to either Proxy or Flow-based.

VDOMs on the same FortiGate can use different inspection modes.

Configuring security profiles

In NAT VDOMs, security profiles are exactly like regular FortiGate unit operation with one exception. In VDOMs,
there are no default security profiles.

If you want security profiles in VDOMs, you must create them yourself. If you have many security profiles to
create in each VDOM, you should consider using a FortiManager unit. It can get existing profiles from a VDOM or
FortiGate unit, and push those profiles down to multiple other VDOMs or FortiGate units.

When VDOMs are enabled, you only need one FortiGuard license for the physical unit, and download FortiGuard
updates once for the physical unit. This can result in a large time and money savings over multiple physical units
if you have many VDOMs.
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Configuring VPNs for a VDOM

Virtual Private Networking (VPN) settings are VDOM-specific, and must be configured within each VDOM.
Configurations for IPsec Tunnel, IPsec Interface, PPTP and SSL are VDOM-specific.

Certificate management

Certificates can be uploaded to the FortiGate certificate store as either global or per-VDOM. Any certificates
uploaded to the global certificate store will be available to all VDOMs on the FortiGate. A certificate uploaded to a
VDOM-specific certificate store are only available for that VDOM.

The following factory default certificates are unique to each VDOM and are automatically generated when a new
VDOM is added:

l Fortinet_CA_SSL
l Fortinet_SSL
l PositiveSSL_CA
l Fortinet_Wifi
l Fortinet_Factory

Example configuration: VDOM in NAT mode

Company A and Company B each have their own internal networks and their own ISPs. They share a FortiGate
unit that is configured with two separate VDOMs, with each VDOM running in NAT mode enabling separate
configuration of network protection profiles. Each ISP is connected to a different interface on the FortiGate unit.

This network example was chosen to illustrate one of the most typical VDOM configurations.

This example has the following sections:

l Network topology and assumptions
l General configuration steps
l Creating the VDOMs
l Configuring the FortiGate interfaces
l Configuring the vdomA VDOM
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l Configuring the vdomB VDOM
l Testing the configuration

Network topology and assumptions

Both companies have their own ISPs and their own internal interface, external interface, and VDOM on the
FortiGate unit.

For easier configuration, the following IP addressing is used:

l all IP addresses on the FortiGate unit end in “.2” such as 10.11.101.2.
l all IP addresses for ISPs end in “.7”, such as 172.20.201.7.
l all internal networks are 10.*.*.* networks, and sample internal addresses end in “.55”.

The IP address matrix for this example is as follows.

Address Company A Company B

ISP 172.20.201.7 192.168.201.7

Internal network 10.11.101.0 10.012.101.0

FortiGate / VDOM 172.20.201.2 (port1)

10.11.101.2 (port4)

192.168.201.2 (port3)

10.012.101.2 (port2)

The Company A internal network is on the 10.11.101.0/255.255.255.0 subnet. The Company B internal network
is on the 10.12.101.0/255.255.255.0 subnet.

There are no switches or routers required for this configuration.

There are no VLANs in this network topology.

The interfaces used in this example are port1 through port4. Different FortiGate models may have different
interface labels. port1 and port3 are used as external interfaces. port2 and port4 are internal interfaces.

The administrator is a super_admin account. If you are a using a non-super_admin account, refer to "Global and
per-VDOM settings" to see which parts a non-super_admin account can also configure.

When configuring security policies in the CLI always choose a policy number that is higher than any existing policy
numbers, select services before profile-status, and profile-status before profile. If these
commands are not entered in that order, they may not be available to enter.

General configuration steps

For best results in this configuration, follow the procedures in the order given. Also, note that if you perform any
additional actions between procedures, your configuration may have different results.

1. Creating the VDOMs
2. Configuring the FortiGate interfaces
3. Configuring the vdomA VDOM, and Configuring the vdomB VDOM
4. Testing the configuration
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Creating the VDOMs

In this example, two new VDOMs are created — vdomA for Company A and vdomB for Company B. These
VDOMs will keep the traffic for these two companies separate while enabling each company to access its own
ISP.

To create two VDOMs - GUI:

1. Log in with a super_admin account.
2. Go toGlobal > System > VDOM, and select Create New.
3. Enter vdomA and select OK.
4. Select OK again to return to the VDOM list.
5. Select Create New.
6. Enter vdomB and select OK.

To create two VDOMs - CLI:

config vdom
edit vdomA
next
edit vdomB

end

Configuring the FortiGate interfaces

This section configures the interfaces that connect to the companies’ internal networks, and to the companies’
ISPs.

All interfaces on the FortiGate unit will be configured with an IP address ending in “.2” such as 10.11.101.2. This
will simplify network administration both for the companies, and for the FortiGate unit global administrator. Also
the internal addresses for each company differ in the second octet of their IP address - Company A is 10.11.*, and
Company B is 10.12.*.

This section includes the following topics:

l Configuring the vdomA interfaces
l Configuring the vdomB interfaces

If you cannot change the VDOM of an network interface it is because something is
referring to that interface that needs to be deleted. Once all the references are deleted
the interface will be available to switch to a different VDOM. For example a common
reference to the external interface is the default static route entry. See Example
configuration: VDOM in NAT mode.

Configuring the vdomA interfaces

The vdomA VDOM includes two FortiGate unit interfaces: port1 and external.

The port4 interface connects the Company A internal network to the FortiGate unit, and shares the internal
network subnet of 10.11.101.0/255.255.255.0.

The external interface connects the FortiGate unit to ISP A and the Internet. It shares the ISP A subnet of
172.20.201.0/255.255.255.0.
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To configure the vdomA interfaces - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select Edit on the port1 interface.
3. Enter the following information and select OK:

Virtual Domain vdomA

Addressing mode Manual

IP/Netmask 172.20.201.2/255.255.255.0

4. Select Edit on the port4 interface.
5. Enter the following information and select OK:

Virtual Domain vdomA

Addressing mode Manual

IP/Netmask 10.11.101.2/255.255.255.0

To configure the vdomA interfaces - CLI:

config global
config system interface

edit port1
set vdom vdomA
set mode static
set ip 172.20.201.2 255.255.255.0

next
edit port4

set vdom ABCDomain
set mode static
set ip 10.11.101.2 255.255.255.0

end

Configuring the vdomB interfaces

The vdomB VDOM uses two FortiGate unit interfaces: port2 and port3.

The port2 interface connects the Company B internal network to the FortiGate unit, and shares the internal
network subnet of 10.12.101.0/255.255.255.0.

The port3 interface connects the FortiGate unit to ISP B and the Internet. It shares the ISP B subnet of
192.168.201.0/255.255.255.0.

To configure the vdomB interfaces - GUI:

1. Go to Global > Network > Interfaces.
2. Select Edit on the port3 interface.
3. Enter the following information and select OK:
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Virtual domain vdomB

Addressing mode Manual

IP/Netmask 192.168.201.2/255.255.255.0

4. Select Edit on the port2 interface.
5. Enter the following information and select OK:

Virtual domain vdomB

Addressing mode Manual

IP/Netmask 10.12.101.2/255.255.255.0

To configure the vdomB interfaces - CLI:

config global
config system interface

edit port3
set vdom vdomB
set mode static
set ip 192.168.201.2 255.255.255.0

next
edit port2

set vdom vdomB
set mode static
set ip 10.12.101.2 255.255.255.0

end

Configuring the vdomA VDOM

With the VDOMs created and the ISPs connected, the next step is to configure the vdomA VDOM.

Configuring the vdomA includes the following:

l Adding vdomA firewall addresses
l Adding the vdomA security policy
l Adding the vdomA default route

Adding vdomA firewall addresses

You need to define the addresses used by Company A’s internal network for use in security policies. This internal
network is the 10.11.101.0/255.255.255.0 subnet.

The FortiGate unit provides one default address, “all”, that you can use when a security policy applies to all
addresses as the source or destination of a packet.

To add the vdomA firewall addresses - GUI:

1. In Virtual Domains, select vdomA.
2. Go to Policy & Objects > Addresses.
3. Select Create New.
4. Enter the following information and select OK:
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Address Name Ainternal

Type Subnet / IP Range

Subnet / IP Range 10.11.101.0/255.255.255.0

Interface port4

To add the ABCDomain VDOM firewall addresses - CLI:

config vdom
edit vdomA

config firewall address
edit Ainternal

set type ipmask
set subnet 10.11.101.0 255.255.255.0

end
end

Adding the vdomA security policy

You need to add the vdomA security policy to allow traffic from the internal network to reach the external network,
and from the external network to internal as well. You need two policies for this domain.

To add the vdomA security policy - GUI:

1. In Virtual Domains, select vdomA.
2. Go to Policy & Objects > IPv4 Policy.
3. Select Create New.
4. Enter the following information and select OK:

Name VDOMA-internal-to-external

Incoming Interface port4

Outgoing Interface port1

Source Address Ainternal

Destination Address all

Schedule Always

Service ALL

Action ACCEPT

5. Select Create New.
6. Enter the following information and select OK:

Name VDOMA-external-to-internal
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Incoming Interface port1

Outgoing Interface port4

Source Address all

Destination Address Ainternal

Schedule Always

Service ALL

Action ACCEPT

To add the vdomA security policy - CLI:

config vdom
edit vdomA

config firewall policy
edit 1

set srcintf port4
set srcaddr Ainternal
set dstintf port1
set dstaddr all
set schedule always
set service ALL
set action accept
set status enable

next
edit 2

set srcintf port1
set srcaddr all
set dstintf port4
set dstaddr Ainternal
set schedule always
set service ALL
set action accept
set status enable

end

Adding the vdomA default route

You also need to define a default route to direct packets from the Company A internal network to ISP A. Every
VDOM needs a default static route, as a minimum, to handle traffic addressed to external networks such as the
Internet.

The administrative distance should be set slightly higher than other routes. Lower admin distances will get
checked first, and this default route will only be used as a last resort.

To add a default route to the vdomA - GUI:

1. For Virtual Domains, select vdomA
2. Go to Network > Static Routes.
3. Select Create New.
4. Enter the following information and select OK:
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Destination IP/Mask 0.0.0.0/0.0.0.0

Device port1

Gateway 172.20.201.7

Distance 20

To add a default route to the vdomA - CLI:

config vdom
edit vdomA

config router static
edit 1

set device port1
set gateway 172.20.201.7

end

Configuring the vdomB VDOM

In this example, the vdomB VDOM is used for Company B. Firewall and routing settings are specific to a single
VDOM.

vdomB includes the FortiGate port2 interface to connect to the Company B internal network, and the FortiGate
port3 interface to connect to ISP B. Security policies are needed to allow traffic from port2 to external and from
external to port2 interfaces.

This section includes the following topics:

l Adding the vdomB firewall address
l Adding the vdomB security policy
l Adding a default route to the vdomB VDOM

Adding the vdomB firewall address

You need to define addresses for use in security policies. In this example, the vdomB VDOM needs an address
for the port2 interface and the “all” address.

To add the vdomB firewall address - GUI:

1. In Virtual Domains, select vdomB.
2. Go to Policy & Objects > Addresses.
3. Select Create New.
4. Enter the following information and select OK:

Address Name Binternal

Type Subnet / IP Range

Subnet / IP Range 10.12.101.0/255.255.255.0

Interface port2
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To add the vdomB firewall address - CLI:

config vdom
edit vdomB

config firewall address
edit Binternal

set type ipmask
set subnet 10.12.101.0 255.255.255.0

end
end

Adding the vdomB security policy

You also need a security policy for the Company B domain. In this example, the security policy allows all traffic.

To add the vdomB security policy - GUI:

1. Log in with a super_admin account.
2. In Virtual Domains, select vdomB.
3. Go to Policy & Objects > IPv4 Policy
4. Select Create New.
5. Enter the following information and select OK:

Name VDOMB-internal-to-external

Incoming Interface port2

Outgoing Interface port3

Source Address Binternal

Destination Address all

Schedule Always

Service ALL

Action ACCEPT

6. Select Create New.
7. Enter the following information and select OK:

Name VDOMB-external-to-internal

Incoming Interface port3

Outgoing Interface port2

Source Address all

Destination Address Binternal

Schedule Always
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Service ALL

Action ACCEPT

To add the vdomB security policy - CLI:

config vdom
edit vdomB

config firewall policy
edit 1

set srcintf port2
set dstintf port3
set srcaddr Binternal
set dstaddr all
set schedule always
set service ALL
set action accept
set status enable

edit 1
set srcintf port3
set dstintf port2
set srcaddr all
set dstaddr Binternal
set schedule always
set service ALL
set action accept
set status enable

end
end

Adding a default route to the vdomB VDOM

You need to define a default route to direct packets to ISP B.

To add a default route to the vdomB VDOM - GUI:

1. Log in as the super_admin administrator.
2. In Virtual Domains, select vdomB.
3. Go to Network > Static Routes.
4. Select Create New.
5. Enter the following information and select OK:

Destination IP/Mask 0.0.0.0/0.0.0.0

Device port3

Gateway 192.168.201.7

Distance 20

To add a default route to the vdomB VDOM - CLI:

config vdom
edit vdomB
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config router static
edit 1

set dst 0.0.0.0/0
set device external
set gateway 192.168.201.7

end
end

Testing the configuration

Once you have completed configuration for both company VDOMs, you can use diagnostic commands, such as
tracert in Windows, to test traffic routed through the FortiGate unit. Alternately, you can use the
traceroute command on a Linux system with similar output.

Possible errors during the traceroute test are:

l “* * * Request timed out” - the trace was not able to make the next connection towards the destination
fast enough

l “Destination host unreachable” - after a number of timed-out responses the trace will give up

Possible reasons for these errors are bad connections or configuration errors.

For additional troubleshooting, see Troubleshooting Virtual Domains.

Testing traffic from the internal network to the ISP

In this example, a route is traced from the Company A internal network to ISP A. The test was run on a Windows
PC with an IP address of 10.11.101.55.

The output here indicates three hops between the source and destination, the IP address of each hop, and that
the trace was successful.

From the Company A internal network, access a command prompt and enter this command:

C:\>tracert 172.20.201.7
Tracing route to 172.20.201.7 over a maximum of 30 hops:
  1   <10 ms   <10 ms   <10 ms  10.11.101.2
  2   <10 ms   <10 ms   <10 ms  172.20.201.2
  3   <10 ms   <10 ms   <10 ms  172.20.201.7
Trace complete.
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A VDOM in Transparent mode is installed between the internal network and the router. In this mode, the VDOM
does not make any changes to IP addresses and only applies security scanning to traffic. When a VDOM is added
to a network in Transparent mode, no network changes are required, except to provide the VDOM with a
management IP address.

Each VDOM on a FortiGate can be configured for NAT mode or Transparent mode, regardless of the operation
mode of other VDOMs on the FortiGate. For more information about NAT mode, see "VDOMs in NAT mode" on
page 3335.

This chapter includes the following sections:

l Transparent Mode Overview
l Using a VDOM in Transparent mode
l VDOMs in transparent mode

Transparent Mode Overview
In transparent mode, a VDOM becomes a layer-2 IP forwarding bridge. This means that Ethernet frames are
forwarded based on destination MAC address, and no other routing is performed. All incoming traffic that is
accepted by the firewall, is broadcast out on all interfaces.

In transparent mode the VDOM is a forwarding bridge, not a switch. A switch can develop a port table and
associated MAC addresses, so that it can bridge two ports to deliver the traffic instead of broadcasting to all
ports. In transparent mode, the VDOM does not following this switch behavior, but instead is the forwarding
bridge that broadcasts all packets out over all interfaces, subject to security policies.

Differences between NAT and Transparent mode

The differences between NAT mode and Transparent mode include:

Differences between NAT and Transparent modes

Features NAT mode Transparent mode

Specific Management IP address
required

No Yes

Perform Network Address Translation
(NAT) Yes Yes

Stateful packet inspection Yes Yes

Layer-2 forwarding Yes Yes

Layer-3 routing Yes No
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Features NAT mode Transparent mode

Unicast Routing / Policy Based routing Yes No

DHCP server Yes No

IPsec VPN Yes Yes

PPTP/L2TP VPN Yes No

SSL VPN Yes No

Security features Yes Yes

VLAN support Yes Yes - limited to VLAN trunks.

Ping servers (dead gateway detection) Yes No

To provide administrative access to a FortiGate unit or VDOM in Transparent mode, you must define a
management IP address and a gateway. This step is not required in NAT mode where you can access the
FortiGate unit through the assigned IP address of any interface where administrative access is permitted.

If you incorrectly set the Transparent mode management IP address for your FortiGate unit, you will be unable to
access your unit through the GUI. In this situation, you will need to connect to the FortiGate unit using the
console cable and change the settings so you can access the unit. Alternately, if your unit has an LCD panel, you
can change the operation mode and interface information through the LCD panel.

Operation mode differences in VDOMs
A VDOM, such as root, can have a maximum of 255 interfaces in Network Address Translation (NAT) mode or
Transparent mode. This includes VLANs, other virtual interfaces, and physical interfaces. To have more than a
total of 255 interfaces configured, you need multiple VDOMs with multiple interfaces on each.

In Transparent mode without VDOMs enabled, all interfaces on the FortiGate unit act as a bridge — all traffic
coming in on one interface is sent back out on all the other interfaces. This effectively turns the FortiGate unit into
a two interface unit no matter how many physical interfaces it has. When VDOMs are enabled, this allows you to
determine how many interfaces to assign to a VDOM running in Transparent mode. If there are reasons for
assigning more than two interfaces based on your network topology, you are able to. However, the benefit of
VDOMs in this case is that you have the functionality of Transparent mode, but you can use interfaces for NAT
traffic as well.

You can add more VDOMs to separate groups of VLAN subinterfaces. When using a FortiGate unit to serve
multiple organizations, this configuration simplifies administration because you see only the security policies and
settings for the VDOM you are configuring.

One essential application of VDOMs is to prevent problems caused when a FortiGate unit is connected to a layer-
2 switch that has a global MAC table. FortiGate units normally forward ARP requests to all interfaces, including
VLAN subinterfaces. It is then possible for the switch to receive duplicate ARP packets on different VLANs. Some
layer-2 switches reset when this happens. As ARP requests are only forwarded to interfaces in the same VDOM,
you can solve this problem by creating a VDOM for each VLAN.

3354 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 32 - Virtual Domains VDOMs in transparent mode

For more information about Transparent mode, see the Transparent Mode & Internal Segmentation Firewall
(ISFW) handbook.

Using a VDOM in Transparent mode
The essential steps to configure a VDOM in Transparent mode are:

l Switching to Transparent mode
l Adding VLAN subinterfaces
l Creating security policies

You can also configure the security profiles that manage antivirus scanning, web filtering and spam filtering.

In Transparent mode, you can access the GUI by connecting to an interface configured for administrative access
and using HTTPS to access the management IP address. In the following examples, administrative access is
enabled by default on the internal interface and the default management IP address is 10.11.0.1.

Switching to Transparent mode

A VDOM is in NAT mode by default when it is created. You must switch it to Transparent mode, and add a
management IP address so you can access the VDOM from your management computer.

Before applying the change to Transparent mode, ensure the VDOM has
administrative access on the selected interface, and that the selected management IP
address is reachable on your network.

Switching the VDOM to Transparent mode cannot be done through the GUI. It must be done through the CLI
only.

To switch the VDOM to Transparent mode - CLI:

config vdom
edit <name>

config system settings
set opmode transparent
set mangeip 10.11.0.99 255.255.255.0

end
end

Adding VLAN subinterfaces

There are a few differences when adding VLANs in Transparent mode compared to NAT mode.

In Transparent mode, VLAN traffic is trunked across the VDOM. That means VLAN traffic cannot be routed,
changed, or inspected. For this reason when you assign a VLAN to a Transparent mode VDOM, you will see the
Addressing Mode section of the interface configuration disappear in from the GUI. It is because with no
routing, inspection, or any activities able to be performed on VLAN traffic the VDOM simply re-broadcasts the
VLAN traffic. This requires no addressing.

Also any routing related features such as dynamic routing or Virtual Router Redundancy Protocol (VRRP) are not
available in Transparent mode for any interfaces.
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Creating security policies

Security policies permit communication between the FortiGate unit’s network interfaces based on source and
destination IP addresses. Typically you will also limit communication to desired times and services for additional
security.

In Transparent mode, the FortiGate unit performs antivirus and antispam scanning on each packet as it passes
through the unit. You need security policies to permit packets to pass from the VLAN interface where they enter
the unit to the VLAN interface where they exit the unit. If there are no security policies configured, no packets will
be allowed to pass from one interface to another.

For more information, see the Firewall handbook.

Example configuration: VDOM in Transparent mode

In this example, the FortiGate unit provides network protection to two organizations— Company A and Company
B. Each company has different policies for incoming and outgoing traffic, requiring three different security policies
and protection profiles.

VDOMs are not required for this configuration, but by using VDOMs the profiles and policies can be more easily
managed on a per-VDOM basis either by one central administrator or separate administrators for each company.
Also future expansion is simply a matter of adding additional VDOMs, whilst not disrupt the existing VDOMs.

For this example, firewalls are only included to deal with web traffic. This is to provide an example without making
configuration unnecessarily complicated.

This example includes the following sections:
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l Network topology and assumptions
l General configuration steps
l Configuring common items
l Creating virtual domains
l Configuring the Company_A VDOM
l Configuring the Company_B VDOM
l Configuring the VLAN switch and router
l Testing the configuration

Network topology and assumptions

Each organization’s internal network consists of a different range of IP addresses:

l 10.11.0.0.0/255.255.0.0 for Company A.
l 10.12.0.0/255.255.0.0 for Company B.

For the procedures in this section, it is assumed that you have enabled VDOM configuration on your FortiGate
unit. For more information, see Virtual Domains Overview.

The VDOM names are similar to the company names for easy recognition. The root VDOM cannot be renamed
and is not used in this example.

Interfaces used in this example are port1 and port2. Some FortiGate models may not have interfaces with these
names. port1 is an external interface. port2 is an internal interface.

General configuration steps

The following steps summarize the configuration for this example. For best results, follow the procedures in the
order given. Also, note that if you perform any additional actions between procedures, your configuration may
have different results.

1. Configuring common items
2. Creating virtual domains
3. Configuring the Company_A VDOM
4. Configuring the Company_B VDOM
5. Configuring the VLAN switch and router
6. Testing the configuration

Configuring common items

Both VDOMs require you configure security profiles. These will be configured the same way, but need to be
configured in both VDOMs.

The relaxed profile allows users to surf websites they are not allowed to visit during normal business hours. Also a
quota is in place to restrict users to one hour of access to these websites to ensure employees do not take long
and unproductive lunches.

To create a strict web filtering profile - GUI:

1. Go to the proper VDOM, and select Security Profiles > Web Filter.
2. Select Create New.
3. Enter strict for the Name.
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4. Expand FortiGuard Web Filtering, and select block for all Categories except Business Oriented, and Other.
5. Block all Classifications except Cached Content, and Image Search.
6. Ensure FortiGuard Quota for all Categories and Classifications is Disabled.
7. Select OK.

To create a strict web filtering profile - CLI:

config vdom
edit <vdom_name>

config webfilter profile
edit strict

config ftgd-wf
set allow g07 g08 g21 g22 c01 c03
set deny g01 g02 g03 g04 g05 g06 c02 c04 c05 c06 c07

end
set web-ftgd-err-log enable

end

To create a relaxed web filtering profile - GUI:

1. Go to the proper VDOM, and select Security Profiles > Web Filter.
2. Select Create New.
3. Enter relaxed for the Name.
4. Expand FortiGuard Web Filtering, and select block for Potentially Security Violating Category, and Spam URL

Classification.
5. Enable FortiGuard Quotas to allow 1 hour for all allowed Categories and Classifications.

Creating virtual domains

The FortiGate unit supports 10 virtual domains. Root is the default VDOM. It cannot be deleted or renamed. The
root VDOM is not used in this example. New VDOMs are created for Company A and Company B

To create the virtual domains - GUI:

1. With VDOMs enabled, select Global > System > VDOM.
2. Select Create New.
3. Enter Company_A for Name, and select OK.
4. Select Create New.
5. Enter Company_B for Name, and select OK.

To create the virtual domains - CLI:

config system vdom
edit Company_A
next
edit Company_B

end

Configuring the Company_A VDOM

This section describes how to add VLAN subinterfaces and configure security policies for the Company_A VDOM.

This section includes the following topics:
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l Adding VLAN subinterfaces
l Creating the Lunch schedule
l Configuring Company_A firewall addresses
l Creating Company_A security policies

Adding VLAN subinterfaces

You need to create a VLAN subinterface on the port2 interface and another one on the port1 interface, both with
the same VLAN ID.

To add VLAN subinterfaces - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select Create New.
3. Enter the following information and select OK:

Name VLAN_100_int

Interface port2

VLAN ID 100

Virtual Domain Company_A

4. Select Create New.
5. Enter the following information and select OK:

Name VLAN_100_ext

Interface port1

VLAN ID 100

Virtual Domain Company_A

To add the VLAN subinterfaces - CLI:

config system interface
edit VLAN_100_int

set interface port2
set vlanid 100
set vdom Company_A

next
edit VLAN_100_ext

set interface port1
set vlanid 100
set vdom Company_A

end
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Creating the Lunch schedule

Both organizations have the same lunch schedule, but only Company A has relaxed its security policy to allow
employees more freedom in accessing the Internet during lunch. Lunch schedule will be Monday to Friday from
11:45am to 2:00pm (14:00).

To create a recurring schedule for lunchtime - GUI:

1. In Company_A VDOM, go to Policy & Objects > Schedules.
2. Select Create New.
3. Enter Lunch as the name for the schedule.
4. Select Mon, Tues,Wed, Thu, and Fri.
5. Set the Start time as 11:45 and set the Stop time as 14:00.
6. Select OK.

To create a recurring schedule for lunchtime - CLI:

config vdom
edit Company_A

config firewall schedule recurring
edit Lunch

set day monday tuesday wednesday thursday friday
set start 11:45
set end 14:00

end

Configuring Company_A firewall addresses

For Company A, its networks are all on the 10.11.0.0 network, so restricting addresses to that domain provides
added security.

To configure Company_A firewall addresses - GUI:

1. In the Company_A VDOM, go to Policy & Objects > Addresses.
2. Select Create New.
3. Enter CompanyA in the Address Name field.
4. Type 10.11.0.0/255.255.0.0 in the Subnet / IP Range field.
5. Select OK.

To configure vdomA firewall addresses - CLI:

config firewall address
edit CompanyA

set type ipmask
set subnet 10.11.0.0 255.255.0.0

end

Creating Company_A security policies

A security policy can include varying levels of security feature protection. This example only deals with web
filtering. The following security policies use the custom security strict and relaxed profiles configured
earlier.

3360 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 32 - Virtual Domains VDOMs in transparent mode

For these security policies, we assume that all protocols will be on their standard ports, such as port 80 for http
traffic. If the ports are changed, such as using port 8080 for http traffic, you will have to create custom services for
protocols with non-standard ports, and assign them different names.

The firewalls configured in this section are:

l internal to external — always allow all, security features - web filtering: strict
l internal to external — Lunch allow all, security features - web filtering:relaxed

Security policies allow packets to travel between the internal VLAN_100 interface to the external interface subject
to the restrictions of the protection profile. Entering the policies in this order means the last one configured is at
the top of the policy list, and will be checked first. This is important because the policies are arranged so if one
does not apply the next is checked until the end of the list.

To configure Company_A security policies - GUI:

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Enter the following information and select OK:

Name CompanyA-lunch

Incoming Interface VLAN_100_int

Outgoing Interface VLAN_100_ext

Source Address CompanyA

Destination Address all

Schedule Lunch

Service all

Action ACCEPT

Security Features enable

Web Filtering relaxed

This policy provides relaxed protection during lunch hours— going from strict down to scan for
protocol options and web filtering. AntiVirus and Email Filtering remain at strict for security— relaxing
them would not provide employees additional access to the Internet and it would make the company
vulnerable.

1. Select Create New.
2. Enter the following information and select OK:

Name CompanyA-strict

Incoming Interface VLAN_100_int

Outgoing Interface VLAN_100_ext
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Source Address CompanyA

Destination Address all

Schedule always

Service all

Action ACCEPT

Security Features enable

Web Filtering strict

This policy enforces strict scanning at all times, while allowing all traffic. It ensures
company policies are met for network security.

4. Verify that the policy list arranged By Sequence to make sure the CompanyA-lunch policy is located above the
CompanyA-strict policy. If necessary, rearrange the policies so that the appropriate policy is applied to outgoing
traffic.

To configure Company_A security policies - CLI:

config vdom
edit Company_A

config firewall policy
edit 1

set name "CompanyA-lunch"
set srcintf VLAN_100_int
set dstintf VLAN_100_ext
set srcaddr all
set dstaddr all
set action accept
set schedule Lunch
set webfiltering relaxed

next
edit 2

set name "CompanyA-strict"
set srcintf VLAN_100_int
set dstintf VLAN_100_ext
set srcaddr all
set dstaddr all
set action accept
set schedule always
set webfiltering strict

end

Configuring the Company_B VDOM

This section describes how to add VLAN subinterfaces and configure security policies for the Company B VDOM.

This section includes the following topics:

l Adding VLAN subinterfaces
l Creating Company_B service groups
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l Configuring Company_B firewall addresses
l Configuring Company_B security policies

Adding VLAN subinterfaces

You need to create a VLAN subinterface on the internal interface and another one on the external interface, both
with the same VLAN ID.

To add VLAN subinterfaces - GUI:

1. Go to Network > Interfaces.
2. Select Create New.
3. Enter the following information and select OK:

Name VLAN_200_int

Interface port2

VLAN ID 200

Virtual Domain Company_B

4. Select Create New.
5. Enter the following information and select OK:

Name VLAN_200_ext

Interface port1

VLAN ID 200

Virtual Domain Company_B

To add the VLAN subinterfaces - CLI:

config system interface
edit VLAN_200_int

set interface internal
set vlanid 200
set vdom Company_B

next
edit VLAN_200_ext

set interface external
set vlanid 200
set vdom Company_B

end

Creating Company_B service groups

Company_B does not want its employees to use any online chat software except NetMeeting, which the company
uses for net conferencing. To simplify the creation of a security policy for this purpose, you create a service group
that contains all of the services you want to restrict. A security policy can manage only one service or one group.
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To create a chat service group - GUI:

1. Go to Policy & Objects > Services and select Create New > Service Group.
2. Enter Chat in theGroup Name field.
3. For each of IRC, AOL, SIP-MSNmessenger and TALK, select the service in the Available Services list and

select the right arrow to add it to theMembers list.
If a particular service does not appear in the Available Services list, see the list in Policy & Objects
> Services. Some services do not appear by default unless edited.

4. Select OK.

To create a games and chat service group - CLI:

config firewall service group
edit Chat

set member IRC SIP-MSNmessenger AOL TALK
end

Configuring Company_B firewall addresses

Company B’s network is all in the 10.12.0.0 network. Security can be improved by only allowing traffic from IP
addresses on that network.

To configure Company_B firewall address - GUI:

1. In the Company_B VDOM, go to Policy & Objects > Addresses.
2. Select Create New.
3. Enter new in the Address Name field.
4. Type 10.12.0.0/255.255.0.0 in the Subnet / IP Range field.
5. Select OK.

To configure Company_B firewall addresses - CLI:

config vdom
edit Company_B

config firewall address
edit all

set type ipmask
set subnet 10.12.0.0 255.255.0.0

end

Configuring Company_B security policies

Security policies allow packets to travel between the internal and external VLAN_200 interfaces subject to the
restrictions of the protection profile.

To configure Company_B security policies - GUI:

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New.
3. Enter the following information and select OK:
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Name CompanyB-deny-games-chat

Incoming Interface VLAN_200_int

Outgoing Interface VLAN_200_ext

Source Address all

Destination Address all

Schedule BusinessDay

Service games-chat

Action DENY

This policy prevents the use of network games or chat programs (except NetMeeting) during business
hours.

4. Enter the following information and select OK:

Name CompanyB-lunch

Incoming Interface VLAN_200_int

Outgoing Interface VLAN_200_ext

Source Address all

Destination Address all

Schedule Lunch

Service HTTP, DNS

Action ACCEPT

Security Features enable

Web Filter relaxed

This policy relaxes the web category filtering during lunch hour.

5. Select Create New.
6. Enter the following information and select OK:

Name CompanyB-strict

Incoming Interface VLAN_200_int

Outgoing Interface VLAN_200_ext

Source Address all
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Destination Address all

Schedule BusinessDay

Service HTTP, DNS

Action ACCEPT

Security Profiles enabled

Web Filter strict

This policy provides rather strict web category filtering during business hours.

7. Select Create New.
8. Enter the following information and select OK:

Name CompanyB-after-hours

Incoming Interface VLAN_200_int

Outgoing Interface VLAN_200_ext

Source Address all

Destination Address all

Schedule always

Service ALL

Action ACCEPT

Security Profiles enabled

Web Filter relaxed

Because it is last in the list, this policy applies to the times and services not covered in preceding policies. This
means that outside of regular business hours, the Relaxed protection profile applies to email and web browsing,
and online chat and games are permitted. Company B needs this policy because its employees sometimes work
overtime. The other companies in this example maintain fixed hours and do not want any after-hours Internet
access.

To configure Company_B security policies - CLI:

config firewall policy
edit 1

set name "CompanyB-deny-games-chat"
set srcintf VLAN_200_int
set srcaddr all
set dstintf VLAN_200_ext
set dstaddr all
set schedule BusinessDay
set service Games
set action deny
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next
edit 2

set name "CompanyB-lunch"
set srcintf VLAN_200_int
set srcaddr all
set dstintf VLAN_200_ext
set dstaddr all
set action accept
set schedule Lunch
set service HTTP
set profile_status enable
set profile Relaxed

next
edit 3

set name "CompanyB-strict"
set srcintf VLAN_200_int
set srcaddr all
set dstintf VLAN_200_ext
set dstaddr all
set action accept
set schedule BusinessDay
set service HTTP
set profile_status enable
set profile BusinessOnly

next
edit 4

set name "CompanyB-after-hours"
set srcintf VLAN_200_int
set srcaddr all
set dstintf VLAN_200_ext
set dstaddr all
set action accept
set schedule always
set service ALL
set profile_status enable
set profile Relaxed

end

Configuring the VLAN switch and router

The Cisco switch is the first VLAN device internal passes through, and the Cisco router is the last device before
the Internet or ISP.

This section includes the following topics:

l Configuring the Cisco switch
l Configuring the Cisco router

Configuring the Cisco switch

On the Cisco Catalyst 2900 ethernet switch, you need to define the VLANs 100, 200 and 300 in the VLAN
database, and then add configuration files to define the VLAN subinterfaces and the 802.1Q trunk interface.

Add this file to Cisco VLAN switch:

!
interface FastEthernet0/1
switchport access vlan 100
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!
interface FastEthernet0/5
switchport access vlan 300
!
interface FastEthernet0/6
switchport trunk encapsulation dot1q
switchport mode trunk
!

Switch 1 has the following configuration:

Port 0/1 VLAN ID 100

Port 0/3 VLAN ID 200

Port 0/6 802.1Q trunk

Configuring the Cisco router

The configuration for the Cisco router in this example is the same as in the basic example, except we add VLAN_
300. Each of the three companies has its own subnet assigned to it.

The IP addressees assigned to each VLAN on the router are the gateway addresses for the VLANs. For example,
devices on VLAN_100 would have their gateway set to 10.11.0.1/255.255.0.0.

!
interface FastEthernet0/0
 switchport trunk encapsulation dot1q
 switchport mode trunk
!
interface FastEthernet0/0.1
 encapsulation dot1Q 100
 ip address 10.11.0.1 255.255.0.0
!
interface FastEthernet0/0.3
 encapsulation dot1Q 200
 ip address 10.12.0.1 255.255.0.0
!

The router has the following configuration:

Port 0/0.1 VLAN ID 100

Port 0/0.3 VLAN ID 200

Port 0/0 802.1Q trunk

Testing the configuration

Use diagnostic commands, such as tracert, to test traffic routed through the network.

You should test traffic between the internal VLANs as well as from the internal VLANs to the Internet to ensure
connectivity.

For additional troubleshooting, see Troubleshooting Virtual Domains.
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This section includes the following topics:

l Testing traffic from VLAN_100 to the Internet
l Testing traffic from VLAN_100 to VLAN_200

Testing traffic from VLAN_100 to the Internet

In this example, a route is traced from VLANs to a host on the Internet. The route target is www.example.com.

From a host on VLAN_100, access a command prompt and enter this command:

C:\>tracert www.example.com
Tracing route to www.example.com [208.77.188.166]
over a maximum of 30 hops:
 1 <10 ms <10 ms <10 ms 10.100.0.1
...
14 172 ms 141 ms 140 ms 208.77.188.166
Trace complete.

The number of steps between the first and the last hop, as well as their IP addresses, will vary depending on your
location and ISP. However, all successful tracerts to www.example.com will start and end with these lines.

Repeat the tracert for VLAN_200.

The tracert for each VLAN will include the gateway for that VLAN as the first step. Otherwise, the tracert should
be the same for each VLAN.

Testing traffic from VLAN_100 to VLAN_200

In this example, a route is traced between two internal networks. The route target is a host on VLAN_200. The
Windows traceroute command tracert is used.

From VLAN_100, access a Windows command prompt and enter this command:

C:\>tracert 10.12.0.2
Tracing route to 10.12.0.2 over a maximum of 30 hops:
1 <10 ms <10 ms <10 ms 10.100.0.1
2 <10 ms <10 ms <10 ms 10.12.0.2
Trace complete.

You can repeat this for different routes in the topology. In each case the IP addresses will be the gateway for the
starting VLAN, and the end point at the ending VLAN.
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Inter-VDOM routing changes this allows VDOMs to communicate internally without using additional physical
interfaces, using VDOM links. VDOM links are virtual interfaces that connect VDOMs. A VDOM link contains a
pair of interfaces with each one connected to a VDOM, and forming either end of the inter-VDOM connection.

This chapter contains the following sections:

l Benefits of inter-VDOM routing
l Configuring VDOM links
l Inter-VDOM configurations
l Dynamic routing over inter-VDOM links
l HA virtual clusters and VDOM links
l Example configuration: Inter-VDOM routing

Benefits of inter-VDOM routing
Inter-VDOM routing has a number of advantages over independent VDOM routing. These benefits include:

l Freed-up physical interfaces
l More speed than physical interfaces
l Continued support for secure firewall policies
l Configuration flexibility

Freed-up physical interfaces

Tying up physical interfaces on the FortiGate unit presents a problem. With a limited number of interfaces
available, configuration options for the old style of communication between VDOMs are very limited. VLANs can
be an answer to this, but they have some limitations.

For example, the FortiGate-800 has 8 physical ethernet ports. If they are assigned 2 per VDOM (one each for
external and internal traffic) there can only be 4 VDOMs at most configured, not the 10 VDOMs the license will
allow. Adding even one additional interface per VDOM to be used to communicate between VDOMs leaves only 2
VDOMs for that configuration, since it would required 9 interfaces for 3 VDOMs. Even using one physical
interface for both external traffic and inter-VDOM communication would severely lower the available bandwidth
for external traffic on that interface.

With the introduction of inter-VDOM routing, traffic can travel between VDOMs internally, freeing up physical
interfaces for external traffic. Using the above example we can use the 4 VDOM configuration and all the
interfaces will have their full bandwidth.

More speed than physical interfaces

Internal interfaces are faster than physical interfaces. Their speed depends on the FortiGate unit CPU and its
load. That means that an inter-VDOM link interface will be faster than a outbound physical interface connected to
another inbound physical interface.

However, while one virtual interface with normal traffic would be considerably faster than on a physical interface,
the more traffic and more internal interfaces you configure, the slower they will become until they are slower than
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the physical interfaces. CPU load can come from other sources such as AV or content scanning. This produces
the same effect—internal interfaces such as inter-VDOM links will be slower.

Continued support for secure firewall policies

VDOMs help to separate traffic based on your needs. This is an important step in satisfying regulations that
require proof of secure data handling. This is especially important to health, law, accounting, and other
businesses that handle sensitive data every day.

By keeping things separate, traffic has to leave the FortiGate unit and re-enter to change VDOMs. This forces
traffic to go through the firewall when leaving and enter through another firewall, keeping traffic secure.

With inter-VDOM routing, the need for the physical interfaces is greatly reduced. However, firewall policies still
need to be in place for traffic to pass through any interface, physical or virtual, and thus provide the same level of
security both internally and externally. Configuration of firewall policies is the same for inter-VDOM links as for
any other interface, and your data will continue to have the high level of security.

Configuration flexibility

A typical VDOM uses at least two interfaces, typically physical interfaces, one for internal and one for external
traffic. Depending on the configuration, more interfaces may be required. This means that the maximum number
of VDOMs configurable on a FortiGate unit using physical interfaces is the number of interfaces available divided
by two. VLANs can increase the number by providing multiple virtual interfaces over a single physical interface,
but VLANs have some limitations. Using physical interfaces for inter-VDOM communication therefore limits the
number of possible configurations on your FortiGate unit.

To overcome this limitation, inter-VDOM links can be created within the FortiGate unit. Using virtual interfaces,
inter-VDOM links free up the physical interfaces for external traffic. Using VDOM links on a FortiGate unit with 8
physical interfaces, you can have 4 VDOMs communicating with each other (meshed configuration) and continue
to have 2 physical interfaces each for internal and external connections. This configuration would have required
20 physical interfaces without inter-VDOM routing. With inter-VDOM routing it only requires 8 physical interfaces,
with the other 12 interfaces being internal VDOM links.

Inter-VDOM routing allows you to make use of standalone VDOMs, Management VDOMs, and Meshed VDOMs
without being limited by the number of physical interfaces on your FortiGate unit. For more information about
these types of VDOMs, see "Inter-VDOM configurations" on page 3371.

Inter-VDOM configurations
By using fewer physical interfaces to inter-connect VDOMs, inter-VDOM links provide you with more configuration
options.

None of these configurations use VLANs to reduce the number of physical interfaces. It is generally assumed that
an internal or client network will have its own internal interface and an external interface to connect to its ISP and
the Internet.

These inter-VDOM configurations can use any FortiGate model with possible limitations based on the number of
physical interfaces. VLANs can be used to work around these limitations.

There are four different types of inter-VDOM configurations:

l Standalone VDOM
l Independent VDOMs
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l Management VDOM
l Meshed VDOM

Standalone VDOM

The standalone VDOM configuration uses a single VDOM on your FortiGate unit — the root VDOM that all
FortiGate units have by default. This is the VDOM configuration you are likely familiar with. It is the default
configuration for FortiGate units before you create additional VDOMs.

The configuration shown above has no VDOM inter-connections and requires no special configurations or
settings.

The standalone VDOM configuration can be used for simple network configurations that only have one
department or one company administering the connections, firewalls and other VDOM-dependent settings.

However, with this configuration, keeping client networks separate requires many interfaces, considerable firewall
design and maintenance, and can quickly become time consuming and complex. Also, configuration errors for
one client network can easily affect other client networks, causing unnecessary network downtime.

Independent VDOMs
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The independent VDOMs configuration uses multiple VDOMs that are completely separate from each other. This
is another common VDOM configuration.

This configuration has no communication between VDOMs and apart from initially setting up each VDOM, it
requires no special configurations or settings. Any communication between VDOMs is treated as if
communication is between separate physical devices.

The independent inter-VDOM configuration can be used where more than one department or one company is
sharing the FortiGate unit. Each can administer the connections, firewalls and other VDOM-dependent settings
for only its own VDOM. To each company or department, it appears as if it has its own FortiGate unit. This
configuration reduces the amount of firewall configuration and maintenance required by dividing up the work.

However, this configuration lacks a management VDOM for VDOMs 1, 2, and 3. This is illustrated in Figure 50.
This management VDOM would enable an extra level of control for the FortiGate unit administrator, while still
allowing each company or department to administer its own VDOM.

Management VDOM

In the management VDOM configuration, the root VDOM is the management VDOM. The other VDOMs are
connected to the management VDOM with inter-VDOM links. There are no other inter-VDOM connections.

The inter-VDOM links connect the management VDOM to the other VDOMs. This does not require any physical
interfaces, and the bandwidth of inter-VDOM links can be faster than physical interfaces, depending on the CPU
workload.

Only the management VDOM is connected to the Internet. The other VDOMs are connected to internal networks.
All external traffic is routed through the management VDOM using inter-VDOM links and firewall policies between
the management VDOM and each VDOM. This ensures the management VDOM has full control over access to
the Internet, including what types of traffic are allowed in both directions. There is no communication directly
between the non-root VDOMs. Security is greatly increased with only one point of entry and exit. Only the
management VDOM needs to be fully managed to ensure network security in this case. Each client network can
manage its own configuration without compromising security or bringing down another client network.

The management VDOM configuration is ideally suited for a service provider business. The service provider
administers the management VDOM with the other VDOMs as customers. These customers do not require a
dedicated IT person to manage their network. The service provider controls the traffic and can prevent the
customers from using banned services and prevent Internet connections from initiating those same banned
services. One example of a banned service might be Instant Messaging (IM) at a company concerned about
intellectual property. Another example could be to limit bandwidth used by file-sharing applications without
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banning that application completely. Firewall policies control the traffic between the customer VDOM and the
management VDOM and can be customized for each customer.

The management VDOM configuration is limited in that the customer VDOMs have no inter-connections. In
many situations this limitation is ideal because it maintains proper security. However, some configurations may
require customers to communicate with each other, which would be easier if the customer VDOMs were inter-
connected.

Meshed VDOM

The meshed VDOMs configuration, including partial and full mesh, has VDOMs inter-connected with other
VDOMs. There is no special feature to accomplish this—they are just complex VDOM configurations.

Partial mesh means only some VDOMs are inter-connected. In a full mesh configuration, all VDOMs are inter-
connected to all other VDOMs. This can be useful when you want to provide full access between VDOMs but
handle traffic differently depending on which VDOM it originates from or is going to.

With full access between all VDOMs being possible, it is extra important to ensure proper security. You can
achieve this level of security by establishing extensive firewall policies and ensuring secure account access for all
administrators and users.

Meshed VDOM configurations can become complex very quickly, with full mesh VDOMs being the most complex.
Ensure this is the proper solution for your situation before using this configuration. Generally, these
configurations are seen as theoretical and are rarely deployed in the field.

Configuring VDOM links
Once VDOMs are configured on your FortiGate unit, configuring inter-VDOM routing and VDOM-links is very
much like creating a VLAN interface. VDOM-links are managed through the GUI or CLI. In the GUI, VDOM link
interfaces are managed in the network interface list.

This section includes the following topics:

l Creating VDOM links
l IP addresses and inter-VDOM links
l Deleting VDOM links
l NAT to Transparent VDOM links
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Creating VDOM links

VDOM links connect VDOMs together to allow traffic to pass between VDOMs as per firewall policies. Inter-
VDOM links are virtual interfaces that are very similar to VPN tunnel interfaces except inter-VDOM links do not
require IP addresses.

To create a VDOM link, you first create the point-to-point interface, and then bind the two interface objects
associated with it to the virtual domains.

In creating the point-to-point interface, you also create two additional interface objects by default. They are called
vlink10 and vlink11 - the interface name you chose with a 1 or a 0 to designate the two ends of the link.

Once the interface objects are bound, they are treated like normal FortiGate interfaces and need to be configured
just like regular interfaces.

The assumptions for this example are as follows:

l Your FortiGate unit has VDOMs enabled and you have 2 VDOMs called customer1 and customer2 already
configured. For more information on configuring VDOMs see Configuring VDOMs.

l You are using a super_admin account.

To configure an inter-VDOM link - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select Create New > VDOM link, enter the following information, and select OK.

Name vlink1

(The name can be up to 11 characters long. Valid characters are letters,
numbers, “-”, and “_”. No spaces are allowed.)

Interface #0

Virtual Domain customer1

IP/Netmask 10.11.12.13/255.255.255.0

Administrative Access HTTPS, SSL

Interface #1

Virtual Domain customer2

IP/Netmask 172.120.100.13/255.255.255.0

Administrative Access HTTPS, SSL

To configure an inter-VDOM link - CLI:

config global
config system vdom-link

edit vlink1
end

config system interface
edit vlink10

set vdom customer1
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next
edit vlink11

set vdom customer2
end

Once you have created and bound the interface ends to VDOMs, configure the appropriate firewall policies and
other settings that you require. To confirm the inter-VDOM link was created, find the VDOM link pair and use the
expand arrow to view the two VDOM link interfaces. You can select edit to change any information.

IP addresses and inter-VDOM links

Besides being virtual interfaces, here is one main difference between inter-VDOM links and regular interfaces—
default inter-VDOM links do not require IP addresses. IP addresses are not required by default because an inter-
VDOM link is an internal connection that can be referred to by the interface name in firewall policies, and other
system references. This introduces three possible situations with inter-VDOM links that are:

l unnumbered - an inter-VDOM link with no IP addresses for either end of the tunnel
l half numbered - an inter-VDOM link with one IP address for one end and none for the other end
l full numbered - an inter-VDOM link with two IP addresses, one for each end.

Not using an IP address in the configuration can speed up and simplify configuration for you. Also you will not use
up all the IP addresses in your subnets if you have many inter-VDOM links.

Half or full numbered interfaces are required if you are doing NAT, either SNAT or DNAT as you need an IP
number on both ends to translate between.

You can use unnumbered interfaces in static routing, by naming the interface and using 0.0.0.0 for the
gateway. Running traceroute will not show the interface in the list of hops. However you can see the interface
when you are sniffing packets, which is useful for troubleshooting.

Deleting VDOM links

When you delete the VDOM link, the two link objects associated with it will also be deleted. You cannot delete the
objects by themselves. The example uses a VDOM routing connection called “vlink1”. Removing vlink1 will also
remove its two link objects vlink10 and vlink11.

Before deleting the VDOM link, ensure all policies, firewalls, and other configurations
that include the VDOM link are deleted, removed, or changed to no longer include the
VDOM link.

To remove a VDOM link - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select Delete for the VDOM link vlink1.

To remove a VDOM link - CLI:

config global
config system vdom-link

delete vlink1
end
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NAT to Transparent VDOM links

Inter-VDOM links can be created between VDOMs in NAT mode and VDOMs in Transparent mode, but it must be
done through the CLI, as the VDOM link type must be changed from the default PPP to Ethernet for the two
VDOMs to communicate. The below example assumes one vdom is in NAT mode and one is Transparent.

An IP address must be assigned to the NAT VDOM’s interface, but no IP address
should be assigned to the Transparent VDOM’s interface.

To configure a NAT to Transparent VDOM link - CLI:

config global
config system vdom-link

edit vlink1
set type ethernet
end

config system interface
edit vlink10

set vdom (interface 1 name)
set ip (interface 1 ip)

next
edit vlink11

set vdom (interface 2 name)
end

Ethernet-type is not recommended for standard NAT to NAT inter-VDOM links, as the default PPP-type link does
not require the VDOM links to have addresses, while Ethernet-type does. VDOM link addresses are explained in
IP addresses and inter-VDOM links.

Dynamic routing over inter-VDOM links
BGP is supported over inter-VDOM links. Unless otherwise indicated, routing works as expected over inter-VDOM
links.

If an inter-VDOM link has no assigned IP addresses to it, it may be difficult to use that interface in dynamic
routing configurations. For example BGP requires an IP address to define any BGP router added to the network.

In OSPF, you can configure a router using a router ID and not its IP address. In fact, having no IP address avoids
possible confusing between which value is the router ID and which is the IP address. However for that router to
become adjacent with another OSPF router it will have to share the same subnet, which is technically impossible
without an IP address. For this reason, while you can configure an OSPF router using an IP-less inter-VDOM link,
it will likely be of limited value to you.

In RIP the metric used is hop count. If the inter-VDOM link can reach other nodes on the network, such as through
a default route, then it may be possible to configure a RIP router on an inter-VDOM link. However, once again it
may be of limited value due to limitations.

As stated earlier, BGP requires an IP address to define a router — an IP-less inter-VDOM link will not work with
BGP.

In Multicast, you can configure an interface without using an IP address. However that interface will be unable to
become an RP candidate. This limits the roles available to such an interface.
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HA virtual clusters and VDOM links
FortiGate HA is implemented by configuring two or more FortiGate units to operate as an HA cluster. To the
network, the HA cluster appears to function as a single FortiGate unit, processing network traffic and providing
normal security services such as firewall, VPN, IPS, virus scanning, web filtering, and spam filtering.

Virtual clustering extends HA features to provide failover protection and load balancing for a FortiGate unit
operating with virtual domains. A virtual cluster consists of a cluster of two FortiGate units operating with virtual
domains. Traffic on different virtual domains can be load balanced between the cluster units.

With virtual clusters (vclusters) configured, inter-VDOM links must be entirely within one vcluster. You cannot
create links between vclusters, and you cannot move a VDOM that is linked into another virtual cluster. If your
FortiGate units are operating in HAmode, with multiple vclusters when you create the vdom-link, the CLI
command config system vdom-link includes an option to set which vcluster the link will be in.

What is virtual clustering?

Virtual clustering is an extension of the FGCP for FortiGate units operating with multiple VDOMS enabled. Virtual
clustering operates in active-passive mode to provide failover protection between two instances of a VDOM
operating on two different cluster units. You can also operate virtual clustering in active-active mode to use HA
load balancing to load balance sessions between cluster units. Alternatively, by distributing VDOM processing
between the two cluster units you can also configure virtual clustering to provide load balancing by distributing
sessions for different VDOMs to each cluster unit.

Virtual clustering and failover protection

Virtual clustering operates on a cluster of two (and only two) FortiGate units with VDOMs enabled. Each VDOM
creates a cluster between instances of the VDOMs on the two FortiGate units in the virtual cluster. All traffic to
and from the VDOM stays within the VDOM and is processed by the VDOM. One cluster unit is the primary unit
for each VDOM and one cluster unit is the subordinate unit for each VDOM. The primary unit processes all traffic
for the VDOM. The subordinate unit does not process traffic for the VDOM. If a cluster unit fails, all traffic fails
over to the cluster unit that is still operating.

Virtual clustering and heartbeat interfaces

The HA heartbeat provides the same HA services in a virtual clustering configuration as in a standard HA
configuration. One set of HA heartbeat interfaces provides HA heartbeat services for all of the VDOMs in the
cluster. You do not have to add a heartbeat interface for each VDOM.

Virtual clustering and HA override

For a virtual cluster configuration, override is enabled by default for both virtual clusters when you:

l Enable VDOM portioning from the GUI by moving virtual domains to virtual cluster 2
l Enter set vcluster2 enable from the CLI config system ha command to enable virtual cluster 2.

Usually you would enable virtual cluster 2 and expect one cluster unit to be the primary unit for virtual cluster 1
and the other cluster unit to be the primary unit for virtual cluster 2. For this distribution to occur override must be
enabled for both virtual clusters. Otherwise you will need to restart the cluster to force it to renegotiate.
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Virtual clustering and load balancing or VDOM partitioning

There are two ways to configure load balancing for virtual clustering. The first is to set the HAmode to active-
active. The second is to configure VDOM partitioning. For virtual clustering, setting the HAMode to active-active
has the same result as active-active HA for a cluster without virtual domains. The primary unit receives all
sessions and load balances them among the cluster units according to the load balancing schedule. All cluster
units process traffic for all virtual domains.

Note: If override is enabled the cluster may renegotiate too often. You can choose to disable override at any time.
If you decide to disable override, for best results, you should disable it for both cluster units.

In a VDOM partitioning virtual clustering configuration, the HAmode is set to active-passive. Even though virtual
clustering operates in active-passive mode you can configure a form of load balancing by using VDOM
partitioning to distribute traffic between both cluster units. To configure VDOM partitioning you set one cluster
unit as the primary unit for some virtual domains and you set the other cluster unit as the primary unit for other
virtual domains. All traffic for a virtual domain is processed by the primary unit for that virtual domain. You can
control the distribution of traffic between the cluster units by adjusting which cluster unit is the primary unit for
each virtual domain.

For example, you could have 4 VDOMs, two of which have a high traffic volume and two of which have a low
traffic volume. You can configure each cluster unit to be the primary unit for one of the high volume VDOMs and
one of the low volume VDOMs. As a result each cluster unit will be processing traffic for a high volume VDOM and
a low volume VDOM, resulting in an even distribution of traffic between the cluster units. You can adjust the
distribution at any time. For example, if a low volume VDOM becomes a high volume VDOM you can move it
from one cluster unit to another until the best balance is achieved. From the GUI you configure VDOM
partitioning by setting the HAmode to active-passive and distributing virtual domains between Virtual Cluster 1
and Virtual Cluster 2. You can also configure different device priorities, port monitoring, and remote link failover,
for Virtual Cluster 1 and Virtual Cluster 2.

From the CLI you configure VDOM partitioning by setting the HAmode to a-p. Then you configure device priority,
port monitoring, and remote link failover and specify the VDOMs to include in virtual cluster 1. You do the same
for virtual cluster 2 by entering the config secondary-vcluster command.

Failover protection does not change. If one cluster unit fails, all sessions are processed by the remaining cluster
unit. No traffic interruption occurs for the virtual domains for which the still functioning cluster unit was the primary
unit. Traffic may be interrupted temporarily for virtual domains for which the failed unit was the primary unit while
processing fails over to the still functioning cluster unit. If the failed cluster unit restarts and rejoins the virtual
cluster, VDOM partitioning load balancing is restored.

Example configuration: Inter-VDOM routing

This example shows how to configure a FortiGate unit to use inter-VDOM routing.
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This section contains the follow topics:

l Network topology and assumptions
l Creating the VDOMs
l Configuring the physical interfaces
l Configuring the VDOM links
l Configuring the firewall and Security Profile settings
l Testing the configuration

Network topology and assumptions

Two departments of a company, Accounting and Sales, are connected to one FortiGate 800 unit. To do its work,
the Sales department receives a lot of email from advertising companies that would appear to be spam if the
Accounting department received it. For this reason, each department has its own VDOM to keep firewall policies
and other configurations separate. Amanagement VDOM makes sense to ensure company policies are followed
for traffic content.

The traffic between Accounting and Sales will be email and HTTPS only. It could use a VDOM link for a meshed
configuration, but we will keep from getting too complex. With the configuration, inter-VDOM traffic will have a
slightly longer path to follow than normal—from one department VDOM, through the management VDOM, and
back to the other department VDOM. Since inter-VDOM links are faster than physical interfaces, this longer path
should not be noticed.

Firewall policies will be in place. For added security, firewall policies will allow only valid office services such as
email, web browsing, and FTP between either department and the Internet. Any additional services that are
required can be added in the future.

The company uses a single ISP to connect to the Internet. The ISP uses DHCP to provide an IP address to the
FortiGate unit. Both departments use the same ISP to reach the Internet.

Other assumptions for this example are as follows:

l Your FortiGate unit has interfaces labelled port1 through port4 and VDOMs are not enabled.
l You are using the super_admin account.
l You have the FortiClient application installed.
l You are familiar with configuring interfaces, firewalls, and other common features on your FortiGate unit.

General configuration steps

This example includes the following general steps. For best results, follow the steps in the order given. Also, note
that if you perform any additional actions between procedures, your configuration may have different results.

1. Creating the VDOMs
2. Configuring the physical interfaces
3. Configuring the VDOM links
4. Configuring the firewall and Security Profile settings
5. Testing the configuration

Creating the VDOMs

This procedure enables VDOMs and creates the Sales and Accounting VDOMs.
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To create the VDOMs - GUI:

1. Log in as the super_admin administrator.
2. Go tothe Dashboard and locate the System Information widget. Enable Virtual Domain.
3. Log in again.
4. Go to Global > System > VDOM.
5. Select Create New, enter Accounting for the VDOM Name, and select OK.
6. Select Create New, enter Sales for the VDOM Name, and select OK.

To create the VDOMs - CLI:

config system global
set vdom enable

end
config system vdom

edit Accounting
next
edit Sales
next

end

Configuring the physical interfaces

Next, the physical interfaces must be configured. This example uses three interfaces on the FortiGate unit - port2
(internal), port3(dmz), and port1(external). port2 and port3 interfaces each have a department’s network
connected. port1 is for all traffic to or from the Internet and will use DHCP to configure its IP address, which is
common with many ISPs.

To configure the physical interfaces - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select Edit for the port2 interface, enter the following information, and select OK.

Alias AccountingLocal

Virtual Domain Accounting

Addressing mode Manual

IP/Netmask 172.100.1.1/255.255.0.0

Administrative Access HTTPS, PING, SSH

Description This is the accounting department internal interface.

3. Select Edit for the port3 interface, enter the following information, and select OK.

Alias SalesLocal

Virtual Domain Sales

Addressing mode Manual
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IP/Netmask 192.168.1.1/255.255.0.0

Administrative Access HTTPS, PING, SSH

Description This is the sales department internal interface.

4. Select Edit for the port1 interface, enter the following information, and select OK.

Alias ManagementExternal

Virtual Domain root

Addressing Mode DHCP

Distance 5

Retrieve default gateway
from server

Enable

Override internal DNS Enable

Administrative Access HTTPS, SSH, SNMP

Description This is the accounting department internal interface.

When the mode is set to DHCP or PPoE on an interface you can set the distance field.
This is the administrative distance for any routes learned through the gateway for this
interface. The gateway is added to the static route table with these values. A lower
distance indicates a preferred route.

To configure the physical interfaces - CLI:

config global
config system interface

edit port2
set alias AccountingLocal
set vdom Accounting
set mode static
set ip 172.100.1.1 255.255.0.0
set allowaccess https ping ssh
set description "The accounting dept internal interface"

next
edit port3

set alias SalesLocal
set vdom Sales
set mode static
set ip 192.168.1.1 255.255.0.0
set allowaccess https ping ssh
set description "The sales dept. internal interface"

next
edit port1

set alias ManagementExternal
set vdom root
set mode DHCP
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set distance 5
set gwdetect enable
set dns-server-override enable
set allowaccess https ssh snmp
set description “The systemwide management interface.”

end

Configuring the VDOM links

To complete the connection between each VDOM and the management VDOM, you need to add the two VDOM
links; one pair is the Accounting - management link and the other is for Sales - management link.

When configuring inter-VDOM links, you do not have to assign IP addresses to the links unless you are using
advanced features such as dynamic routing that require them. Not assigning IP addresses results in faster
configuration, and more available IP addresses on your networks.

If you require them, or if you simply want to assign IP addresses for clarity can do so.

To configure the Accounting and management VDOM link - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select the expand arrow to select Create New > VDOM link.
3. Enter the following information, and select OK.

Name AccountVlnk

Interface #0

Virtual Domain Accounting

IP/Netmask 0.0.0.0/0.0.0.0

Administrative
Access

HTTPS, PING, SSH

Description The Accounting VDOM side of the link.

Interface #1

Virtual Domain root

IP/Netmask 0.0.0.0/0.0.0.0

Administrative
Access

HTTPS, PING, SSH

Description The Management VDOM side of the link.

To configure the Accounting and management VDOM link - CLI:

config global
config system vdom-link

edit AccountVlnk
next

end
config system interface
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edit AccountVlnk0
set vdom Accounting
set ip 0.0.0.0 0.0.0.0
set allowaccess https ping ssh
set description “Accounting side of the VDOM link“

next
edit AccountVlnk1

set vdom root
set ip 0.0.0.0 0.0.0.0
set allowaccess https ping ssh
set description “Management side of the VDOM link“

end

To configure the Sales and management VDOM link - GUI:

1. Go toGlobal > Network > Interfaces.
2. Select the expand arrow and select Create New > VDOM link.
3. Enter the following information, and select OK.

Name SalesVlnk

Interface #0

Virtual Domain Sales

IP/Netmask 0.0.0.0/0.0.0.0

Administrative
Access

HTTPS, PING, SSH

Description The Sales VDOM side of the link.

Interface #1

Virtual Domain root

IP/Netmask 0.0.0.0/0.0.0.0

Administrative
Access

HTTPS, PING, SSH

Description The Management VDOM side of the link.

To configure the Sales and management VDOM link - CLI:

config global
config system vdom-link

edit SalesVlnk
end
config system interface

edit SalesVlnk0
set vdom Accounting
set ip 0.0.0.0 0.0.0.0
set allowaccess https ping ssh
set description "Sales side of the VDOM link"

next
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edit SalesVlnk1
set vdom root
set ip 0.0.0.0 0.0.0.0
set allowaccess https ping ssh
set description "Management side of the VDOM link"

end
end

Configuring the firewall and Security Profile settings

With the VDOMs, physical interfaces, and VDOM links configured the firewall must now be configured to allow
the proper traffic. Firewalls are configured per-VDOM, and firewall objects must be created for each VDOM
separately.

For this example, the firewall group of services allowed between the internal networks and the Internet are the
basic services for web browsing, file transfer, and email. These include: HTTP, HTTPS, SSL, FTP, DNS, NTP,
POP3, and SMTP.

The only services allowed between Sales and Accounting are secure web browsing (HTTPS) and email (POP3
and SMTP).

The limited number of services ensures security between departments. The list of
services can be expanded in the future if needed.

Security profile settings will block all non-essential business websites while logging all web traffic, scan and file
filter all web and email protocols, and block game and peer-to-peer applications using application control.

For added security, FortiClient is required on internal computers with AntiVirus scanning configured. This is
enforced byEndpoint NAC in firewall policies.

Using firewall addresses makes the firewall policies easier to read. Also if any changes need to be made in the
future, you can simply update the addresses without changing the firewall policies. The addresses required are:

l AccountingLocal - all traffic from the internal accounting network
l AccountingVlnk - all traffic from the VDOM link between accounting and management VDOMs
l SalesLocal - all traffic from the internal sales network
l SalesVlnk - all traffic from the VDOM link between sales and management VDOM.

The Accounting VDOM requires AccountingLocal, AccountingVlnk, and SalesLocal. The Sales
VDOM requires SalesLocal, SalesVlnk, and AccountingLocal.

This section includes the following topics:

l Configuring firewall service groups
l Configuring Security Profile settings for the Accounting VDOM
l Configuring firewall settings for the Accounting VDOM
l Configuring Security Profile settings for the Sales VDOM
l Configuring firewall settings for the Sales VDOM
l Configuring firewall settings between the Accounting and Sales VDOMs
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Configuring firewall service groups

Service groups are an easy way to manage multiple services, especially if the same services are used on different
networks.

The two service groups used here are intended for normal office traffic to the Internet, and for restricted traffic
between departments. In both cases network traffic will be limited to the services listed to prevent any potential
security risks or bandwidth-robbing applications.

These service groups can be changed as needed to either include additional valid services that are being used on
the network, or to exclude services that are not required. Also, custom services can be created as needed for
applications that are not listed.

To configure two firewall service groups - GUI:

1. Open the Accounting VDOM.
2. Go to Policy & Objects > Services and select Create New > Service Group.
3. Select Create New, enter the following information, and select OK.

Group Name OfficeServices

Members HTTP, HTTPS, SSL, FTP, DNS, NTP, POP3, PING, SMTP

4. Select Create New, enter the following information, and select OK.

Group Name AccountingSalesServices

Members HTTPS, POP3, PING, SMTP

To configure two firewall service groups - CLI:

config vdom
edit Accounting

config firewall service group
edit OfficeServices

set member HTTP HTTPS SSH FTP DNS NTP POP3 PING SMTP
next
edit AccountingSalesServices

set member HTTPS POP3 PING SMTP
end

end

Configuring Security Profile settings for the Accounting VDOM

Security Profile settings include web filtering, antivirus, application control, and other features. This example just
uses those three features to ensure that

l the business environment is free from viruses
l employees do not surf grossly inappropriate websites, and
l employees do not use games or peer-to-peer applications at work.
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To configure web filtering for the Accounting VDOM - GUI:

1. Open the Accounting VDOM.
2. Go to Security Profiles > Web Filter.
3. Select Create New.
4. Enter webStrict for the Name.
5. Select the arrow to expand the FortiGuard Web Filtering section.
6. Block all Categories except Business Oriented, Other, and Unrated.
7. Block all Classifications except Image Search..
8. Log all Categories and Classifications.
9. Select OK.

To configure AntiVirus for the Accounting VDOM - GUI:

1. Open the Accounting VDOM.
2. Go to Security Profiles > AntiVirus.
3. Select Create New.
4. Enter avStrict for the Name.
5. Set Detect Virues to Block and enable all Inspected Protocols.
6. Select OK.

To configure application control for the Accounting VDOM - GUI:

1. Open the Accounting VDOM.
2. Go to Security Profiles > Application Control.
3. Select Create New (+ button at top right of page).
4. Enter appStrict forName and select OK.
5. Select Create New.
6. In Filters, set Category to game.
7. In Applications/Settings, enter the following, and select OK.

Action Block

Packet Logging Enable

8. Select Create New.
9. In Filters, set Category to p2p.
10. In Applications/Settings, enter the following, and select OK.

Action Block

Packet Logging Enable

11. Select Apply.

To configure application control for the Accounting VDOM - CLI:

config vdom
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edit Accounting
config application list

edit appStrict
config entries

edit 1
set category 2

next
edit 2

set category 8
end

end
end

Configuring firewall settings for the Accounting VDOM

This configuration includes two firewall addresses and two firewall policies for the Accounting VDOM - one for the
internal network, and one for the VDOM link with the management VDOM (root).

For added security, all traffic allowed will be scanned. Only valid office traffic will be allowed using the service
group OfficeServices.

Note the spelling of AccountVlnk which is due to the eleven character limit on VDOM link names.

To configure firewall addresses - GUI:

1. Open the Accounting VDOM.
2. Select Policy & Objects > Addresses.
3. Select Create New, enter the following information, and select OK.

Address Name AccountingLocal

Type Subnet/ IP Range

Subnet / IP Range 172.100.0.0

Interface port1

4. Select Create New, enter the following information, and select OK.

Address Name AccountManagement

Type Subnet/ IP Range

Subnet / IP Range 10.0.1.0

Interface AccountVlnk

To configure firewall addresses - CLI:

config vdom
edit Accounting

config firewall address
edit AccountingLocal

set type iprange
set subnet 172.100.0.0
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set associated-interface port1
next
edit AccountManagement

set type iprange
set subnet 10.0.1.0
set associated-interface AccountVlnk

end
end

To configure the firewall policies from AccountingLocal to the Internet - GUI:

1. Open the Accounting VDOM.
2. Go to Policy & Objects > IPv4 Policy.
3. Select Create New, enter the following information, and then select OK.

Name Accounting-Local-to-Management

Incoming Interface port2

Outgoing Interface AccountVlnk

Source Address AccountingLocal

Destination Address AccountManagement

Schedule always

Service OfficeServices

Action ACCEPT

Enable NAT enable

Security Features enabled

Web Filtering webStrict

AntiVirus Filtering avStrict

Application Control appStrict

4. Open the root VDOM.
5. Go to Policy & Objects > IPv4 Policy.
6. Select Create New, enter the following information, and then select OK.

Name Accounting-VDOM-to-Internet

Incoming Interface AccountVlnk

Outgoing Interface ManagementExternal

Source Address AccountManagement
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Destination Address all

Schedule always

Service OfficeServices

Action ACCEPT

Enable NAT enable

Security Features enabled

Web Filtering webStrict

AntiVirus Filtering avStrict

Application Control appStrict

To configure the firewall policies from AccountingLocal to Internet - CLI:

config vdom
edit Accounting

config firewall policy
edit 1

set name "Accounting-Local-to-Management"
set srcintf port2
set dstintf AccountVlnk
set srcaddr AccountingLocal
set dstaddr AccountManagement
set action accept
set schedule always
set service OfficeServices
set nat enable
set av-profile avStrict
set webfilter-profile webStrict
set application-list appStrict

end
end

config vdom
edit root

config firewall policy
edit 2

set name "Accounting-VDOM-to-Internet"
set srcintf AccountVlnk
set dstintf port1
set srcaddr AccountManagement
set dstaddr all
set action accept
set schedule always
set service OfficeServices
set nat enable
set av-profile scan
set webfilter-profile scan
set application-list AppControlList

end
end
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To configure the firewall policies from Internet to AccountingLocal - GUI:

1. Open the root VDOM.
2. Go to Policy & Objects > IPv4 Policy.
3. Select Create New, enter the following information, and select OK.

Name Internet-access-to-Accounting-VDOM

Incoming Interface port1

Outgoing Interface AccountVlnk

Source Address all

Destination Address AccountManagement

Schedule always

Service OfficeServices

Action ACCEPT

Enable NAT enable

Security Features enabled

Web Filtering webStrict

AntiVirus Filtering avStrict

Application Control appStrict

4. Open the Accounting VDOM.
5. Go to Policy & Objects > IPv4 Policy.
6. Select Create New, enter the following information, and select OK.

Name Management-access-to-Accounting-local

Incoming Interface AccountVlnk

Outgoing Interface port2

Source Address AccountManagement

Destination Address AccountingLocal

Schedule always

Service OfficeServices

Action ACCEPT

Enable NAT enable
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Security Features enabled

Web Filtering webStrict

AntiVirus Filtering avStrict

Application Control appStrict

To configure the firewall policies from Internet to AccountingLocal - CLI:

config vdom
edit root

config firewall policy
edit 3

set name "Internet-access-to-Accounting-VDOM"
set srcintf port1
set dstintf AccountVlnk
set srcaddr all
set dstaddr AccountManagement
set action accept
set schedule always
set service OfficeServices
set nat enable
set av-profile avStrict
set webfilter-profile webStrict
set application-list appstrict

end
end

config vdom
edit Accounting

config firewall policy
edit 4

set name "Management-access-to-Accounting-local"
set srcintf AccountVlnk
set dstintf port2
set srcaddr AccountManagement
set dstaddr AccountingLocal
set action accept
set schedule always
set service OfficeServices
set nat enable
set av-profile avStrict
set webfilter-profile webStrict
set application-list appstrict

end
end

Configuring Security Profile settings for the Sales VDOM

Security profile settings include web filtering, antivirus, application control, and other features. This example just
uses those three features to ensure that

l the business environment is free from viruses
l employees do not surf grossly inappropriate websites, and
l employees do not use games or peer-to-peer applications at work.
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Note that Sales web traffic is different from Accounting, and web filtering is different to account for this.

To configure web filtering for the Sales VDOM - GUI:

1. Open the Sales VDOM.
2. Go to Security Profiles > Web Filter.
3. Select Create New.
4. Enter webStrict for the Name.
5. In FortiGuard Categories, select all of the categories except Bandwidth Consuming, General Interest -

Business and Unrated.
6. In Change Action for Selected Categories select Block.
7. Select Apply.

To configure web filtering for the Sales VDOM - CLI:

config vdom
edit Sales

config webfilter profile
edit webStrict

config ftgd-wf
set allow g07 g08 g21 g22 c01 c03
set deny g01 g02 g03 g04 g05 g06 c02 c04 c05 c06 c07

end
set web-ftgd-err-log enable

end
end

To configure AntiVirus for the Sales VDOM - GUI:

1. Open the Sales VDOM.
2. Go to Security Profiles > AntiVirus.
3. Select Create New.
4. Enter avStrict for the Name.
5. Set Detect Virues to Block and enable all Inspected Protocols.
6. Select Apply.

To configure AntiVirus for the Sales VDOM - CLI:

config vdom
edit Sales

config antivirus profile
edit "avStrict"

config http
set options scan file-filter

end
config ftp

set options scan file-filter
end
config imap

set options scan file-filter
end
config pop3

set options scan file-filter
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end
config smtp

set options scan file-filter
end
config nntp

set options scan file-filter
end
config im

set options scan file-filter
end
set filepattable 1
set av-virus-log enable
set av-block-log enable

end
end

To configure application control for the Sales VDOM - GUI:

1. Open the Accounting VDOM.
2. Go to Security Profiles > Application Control.
3. Select Create New (+ button at top right of page).
4. Enter appStrict forName and select OK.
5. Select Create New.
6. In Filters, set Category to game.
7. In Applications/Settings, enter the following, and select OK.

Action Block

Packet Logging Enable

8. Select Create New.
9. In Filters, set Category to p2p.
10. In Applications/Settings, enter the following, and select OK.

Action Block

Packet Logging Enable

11. Select Apply.

To configure application control for the Sales VDOM - CLI:

config vdom
edit Sales

config application list
edit "appStrict"

config entries
edit 1

set category 2
next
edit 2

set category 8
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end
end

end

Configuring firewall settings for the Sales VDOM

Like the Accounting firewall settings, this configuration includes two firewall addresses and two firewall policies
for the sales VDOM: one for the internal network, and one for the VDOM link with the management VDOM.

When entering the CLI commands, the number of the firewall policies must be high enough to be a new policy.
Depending on the number of firewall policies on your FortiGate unit, this may require starting at a higher number
than the 6 required for the default configuration. This number is added automatically when you configure firewall
policies using the web manager interface.

The FortiClient application must be used on Sales network computers to ensure additional protection for the
sensitive information and for protection against spam.

To configure firewall addresses - GUI:

1. Open the Sales VDOM.
2. Go to Policy & Objects > Addresses.
3. Select Create New, enter the following information, and select OK.

Address Name SalesLocal

Type Subnet / IP Range

Subnet / IP Range 172.100.0.0

Interface port3

4. Go to Policy & Objects > Addresses.
5. Select Create New, enter the following information, and select OK.

Address Name SalesManagement

Type Subnet / IP Range

Subnet / IP Range 10.0.1.0

Interface SalesVlnk

To configure the firewall addresses - CLI:

config vdom
edit Sales

config fireall address
edit SalesLocal

set type iprange
set subnet 172.100.0.0
set associated-interface port2

next
edit SalesManagement

set type iprange
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set subnet 10.0.1.0
set associated-interface SalesVlnk

end
end

To configure the firewall policies from SalesLocal to the Internet - GUI:

1. Open the Sales VDOM.
2. Go to Policy & Objects > IPv4 Policy.
3. Select Create New, enter the following information, and select OK.

Name Sales-local-to-Management

Incoming Interface port3

Outgoing Interface SalesVlnk

Source Address SalesLocal

Destination Address SalesManagement

Schedule always

Service OfficeServices

Action ACCEPT

Log Allowed Traffic enabled

4. Open the root VDOM.
5. Go to Policy & Objects > IPv4 Policy.
6. Select Create New, enter the following information, and select OK.

Name Sales-VDOM-to-Internet

Incoming Interface SalesVlnk

Outgoing Interface ManagementExternal

Source Address SalesManagement

Destination Address all

Schedule always

Service OfficeServices

Action ACCEPT

Log Allowed Traffic enabled

To configure the firewall policies from SalesLocal to the Internet - CLI:

config vdom
edit root
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config firewall policy
edit 6

set name "Sales-local-to-Management"
set srcintf port2
set srcaddr SalesLocal
set dstintf SalesVlnk
set dstaddr SalesManagement
set schedule always
set service OfficeServices
set action accept
set logtraffic enable

end
end

config vdom
edit Sales

config firewall policy
edit 7

set name "Sales-VDOM-to-Internet"
set srcintf SalesVlnk
set srcaddr SalesManagement
set dstintf external
set dstaddr all
set schedule always
set service OfficeServices
set action accept
set logtraffic enable

end
end

To configure the firewall policies from the Internet to SalesLocal - GUI:

1. Open the root VDOM.
2. Go to Policy & Objects > IPv4 Policy.
3. Select Create New, enter the following information, and select OK.

Name Internet-access-to-Sales-VDOM

Incoming Interface ManagementExternal

Outgoing Interface SalesVlnk

Source Address all

Destination Address SalesManagement

Schedule always

Service OfficeServices

Action ACCEPT

Protection Profile scan

Log Allowed Traffic enabled
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4. Open the Sales VDOM.
5. Go to Policy & Objects > IPv4 Policy.
6. Select Create New, enter the following information, and select OK.

Name Management-access-to-Sales-local

Incoming Interface SalesVlnk

Outgoing Interface port2

Source Address SalesManagement

Destination Address SalesLocal

Schedule always

Service OfficeServices

Action ACCEPT

Log Allowed Traffic enabled

To configure the firewall policies from the Internet to SalesLocal - CLI:

config vdom
edit root

config firewall policy
edit 8

set name "Internet-access-to-Sales-VDOM"
set srcintf external
set srcaddr all
set dstintf SalesVlnk
set dstaddr SalesManagement
set schedule always
set service OfficeServices
set action accept
set logtraffic enable

end
end

config vdom
edit Sales

config firewall policy
edit 9

set name "Management-access-to-Sales-local"
set srcintf SalesVlnk
set srcaddr SalesManagement
set dstintf port2
set dstaddr SalesLocal
set schedule always
set service OfficeServices
set action accept
set logtraffic enable

end
end
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Configuring firewall settings between the Accounting and Sales VDOMs

Firewall policies are required for any communication between each internal network and the Internet. Policies are
also required for the two internal networks to communicate with each other through the management VDOM.

The more limited AccountingSalesServices group of services will be used between Sales and Accounting to
ensure the traffic is necessary business traffic only. These policies will result in a partially meshed VDOM
configuration. The FortiClient application must be used to ensure additional protection for the sensitive
accounting information.

Two firewall policies are required to allow traffic in both directions between Sales and Accounting.

To configure the firewall policy between Sales and Accounting on the management VDOM - GUI:

1. Open the root VDOM.
2. Go to Policy & Objects > IPv4 Policy.
3. Select Create New, enter the following information, and select OK.

Name Sales-VDOM-to-Accounting-VDOM

Incoming Interface SalesVlnk

Outgoing Interface AccountVlnk

Source Address SalesManagement

Destination Address AccountingManagement

Schedule always

Service AccountingSalesServices

Action ACCEPT

Protection Profile scan

Log Allowed Traffic enabled

4. Go to Policy & Objects > IPv4 Policy.
5. Select Create New, enter the following information, and select OK.

Name Accounting-VDOM-to-Sales-VDOM

Incoming Interface AccountVlnk

Outgoing Interface SalesVlnk

Source Address AccountingManagement

Destination Address SalesManagement

Schedule always
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Service AccountingSalesServices

Action ACCEPT

Log Allowed Traffic enabled

To configure the firewall policy between Sales and Accounting on the management VDOM - CLI:

config vdom
edit root

config system firewall policy
edit 9

set name "Sales-VDOM-to-Accounting-VDOM"
set srcintf SalesVlnk
set srcaddr SalesManagement
set dstintf AccountVlnk
set dstaddr AccountManagement
set schedule always
set service AccountingSalesServices
set action accept
set logtraffic enable

next
edit 10

set name "Accounting-VDOM-to-Sales-VDOM"
set srcintf AccountVlnk
set srcaddr AccountManagement
set dstintf SalesVlnk
set dstaddr SalesManagement
set schedule always
set service AccountingSalesServices
set action accept
set logtraffic enable

end
end

Testing the configuration

Once the inter-VDOM routing has been configured, tests must be conducted to confirm proper operation. If there
are any problems, use the troubleshooting tips to resolve them.

This section includes the following topics:

l Testing connectivity
l Troubleshooting Tips

Testing connectivity

Testing connectivity ensures that physical networking connections as well as FortiGate unit interface
configurations, including firewall policies, are properly configured.

The easiest way to test connectivity is to use the ping and traceroute commands to confirm the connectivity
of different routes on the network. Include testing:

l from AccountingLocal to Internet
l from Internet to AccountingLocal
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l from SalesLocal to Internet
l from Internet to SalesLocal
l from AccountingLocal to SalesLocal.

When using the commands on a Windows computer, go to a command line prompt and enter either ping <IP
address> or tracert <IP address>.

When using the commands on a FortiGate unit, go to the CLI and enter either exec ping <IP address> or
exec traceroute <IP address>.

Troubleshooting Tips

When there are problems with connectivity, the following troubleshooting tips will help resolve the issues.

l If a multiple hop test, such as traceroute, is not successful then reduce it to a single hop to simplify the test. Test
each link of the path to see which hop is down. If all hops are up, check the FortiGate unit policies to ensure they
allow basic traffic to flow as expected.

l If ping does not work, confirm that the FortiGate unit interfaces have Ping enabled and also ensure Ping is enabled
in the firewall policies. Otherwise the Ping traffic will be blocked.

l If one protocol does not work but others do work, check the FortiGate unit firewall policies for that one protocol to
ensure it is allowed.

l If there are unexplained connectivity problems, check the local computer to ensure it does not have a software
firewall running that may be blocking traffic. MSWindows computers have a firewall running by default that can
cause problems.

For additional troubleshooting, see Troubleshooting Virtual Domains.
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When you are configuring VDOMs you may run into some issues, with your VDOM configuration, your network
configuration, or your device setup. This section addresses common problems and specific concerns that an
administrator of a VDOM network may have.

This section includes:

l VDOM admin having problems gaining access
l FortiGate unit running very slowly
l General VDOM tips and troubleshooting

VDOM admin having problems gaining access
With VDOMs configured, administrators have an extra layer of permissions and may have problems accessing
their information.

Confirm the admin’s VDOM

Each administrator account, other than the super_admin account, is tied to one specific VDOM. That
administrator is not able to access any other VDOM. It may be possible they are trying to access the wrong
VDOM.

Confirm the VDOM’s interfaces

An administrator can only access their VDOM through interfaces that are assigned to that VDOM. If interfaces on
that VDOM are disabled or unavailable there will be no method of accessing that VDOM by its local administrator.
The super_admin will be required to either bring up the interfaces, fix the interfaces, or move another interface to
that VDOM to restore access.

Confirm the VDOMs admin access

As with all FortiGate units, administration access on the VDOM’s interfaces must be enabled for that VDOM’s
administrators to gain access. For example if SSH is not enabled, that is not available to administrators.

To enable admin access, the super_admin will go to theGlobal > Network > Interfaces page, and for the
interface in question enable the admin access.

FortiGate unit running very slowly
You may experience a number of problems resulting from your FortiGate unit being overloaded. These problems
may appear as:

l CPU and memory threshold limits exceeded on a continual basis
l AV failopen happening on a regular basis
l dropped traffic or sessions due to lack of resources

These problems are caused by a lack of system resources. There are a number of possible reasons for this.
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Too many VDOMs

If you have configured many VDOMs on your system, past the default ten VDOMs, this could easily be your
problem.

Each VDOM you create on your FortiGate unit requires system resources to function - CPU cycles, memory, and
disk space. When there are too many VDOMs configured there are not enough resources for operation. This may
be a lack of memory in the session table, or no CPU cycles for processing incoming IPS traffic, or even a full disk
drive.

Go toGlobal > System > VDOM and see the number of configured VDOMs on your system. If you are running
500 or more VDOMs, you must have a FortiGate 5000 chassis. Otherwise you need to reduce the number of
VDOMs on your system to fix the problem. Even if you have the proper hardware, you may encounter noticeably
slow throughput if you are using advanced features such as security profiles or deep content inspection with many
configured VDOMs.

One or more VDOMs are consuming all the resources

If you have sufficient hardware to support the number of VDOMs you are running, check the global resources on
your FortiGate unit. At a glance it will tell you if you are running out of a particular resource such as sessions, or
users. If this is the case, you can then check your VDOMs to see if one particular VDOM is using more than its
share of resources. If that is the case you can change the resource settings to allow that VDOM (or those VDOMs)
fewer resources and in turn allow the other VDOMs access to those resources.

Too many Security Features in use

It is likely that reducing the Security Features in use regardless of number of VDOMs will greatly improve overall
system performance and should be considered as an option.

Finally it is possible that your FortiGate unit configuration is incorrect in some other area, which is using up all
your resources. For example, forgetting that you are running a network sniffer on an interface will create
significant amounts of traffic that may prevent normal operation.

General VDOM tips and troubleshooting
Besides ping and traceroute, there are additional tools for troubleshooting your VDOM configurations. These
include packet sniffing and debugging the packet flow.

Perform a sniffer trace

When troubleshooting networks, it helps to look inside the headers of packets to determine if they are traveling
along the route you expect that they are. Packet sniffing can also be called a network tap, packet capture, or logic
analyzing.

If your FortiGate unit has NP interfaces that are offloading traffic, this will change the
sniffer trace. Before performing a trace on any NP interfaces, you should disable
offloading on those interfaces.

What sniffing packets can tell you

If you are running a constant traffic application such as ping, packet sniffing can tell you if the traffic is reaching
the destination, what the port of entry is on the FortiGate unit, if the ARP resolution is correct, and if the traffic is
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being sent back to the source as expected.

Sniffing packets can also tell you if the Fortigate unit is silently dropping packets for reasons such as RPF
(Reverse Path Forwarding), also called Anti Spoofing, which prevents an IP packet from being forwarded if its
Source IP does not either belong to a locally attached subnet (local interface), or be part of the routing between
the FortiGate and another source (static route, RIP, OSPF, BGP). Note that RPF can be disabled by turning on
asymmetric routing in the CLI (config system setting, set asymmetric enable), however this will
disable stateful inspection on the FortiGate unit and cause many features to be turned off.

If you configure virtual IP addresses on your Fortigate unit, it will use those addresses
in preference to the physical IP addresses. You will notice this when you are sniffing
packets because all the traffic will be using the virtual IP addresses. This is due to the
ARP update that is sent out when the VIP address is configured.

How to sniff packets

When you are using VDOMs, you must be in a VDOM to access the diag sniffer command. At the global
level, the command is not available. This is limit the packets only to the ones on your VDOM, and protects the
privacy of other VDOM clients.

The general form of the internal FortiOS packet sniffer command is:

diag sniffer packet <interface_name> <'filter'> <verbose> <count>

To stop the sniffer, type CTRL+C.
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<interface_name> The name of the interface to sniff, such as “port1” or “internal”. This can
also be “any” to sniff all interfaces.

<'filter'>

What to look for in the information the sniffer reads. none indicates no
filtering, and all packets will be displayed as the other arguments indicate.

The filter must be inside single quotes (‘).

<verbose> The level of verbosity as one of:

1 - print header of packets

2 - print header and data from IP of packets

3 - print header and data from Ethernet of packets

<count> The number of packets the sniffer reads before stopping. If you don’t put a
number here, the sniffer will run forever unit you stop it with <CTRL C>.

For a simple sniffing example, enter the CLI command diag sniffer packet port1 none 1 3. This
will display the next 3 packets on the port1 interface using no filtering, and using verbose level 1. At this verbosity
level you can see the source IP and port, the destination IP and port, action (such as ack), and sequence
numbers.

In the output below, port 443 indicates these are HTTPS packets, and 172.20.120.17 is both sending and
receiving traffic.

Head_Office_620b # diag sniffer packet port1 none 1 3
interfaces=[port1]
filters=[none]
0.545306 172.20.120.17.52989 -> 172.20.120.141.443: psh 3177924955 ack 1854307757

0.545963 172.20.120.141.443 -> 172.20.120.17.52989: psh 1854307757 ack 3177925808

0.562409 172.20.120.17.52988 -> 172.20.120.141.443: psh 4225311614 ack 3314279933

For a more advanced example of packet sniffing, the following commands will report packets on any interface
travelling between a computer with the host name of PC1 and the computer with the host name of PC2. With
verbosity 4 and above, the sniffer trace will display the interface names where traffic enters or leaves the
FortiGate unit. Remember to stop the sniffer, type CTRL+C. Note that PC1 and PC2 may be VDOMs.

FGT# diagnose sniffer packet any "host <PC1> or host <PC2>" 4

or

FGT# diagnose sniffer packet any "(host <PC1> or host <PC2>) and icmp" 4

The following sniffer CLI command includes the ARP protocol in the filter which may be useful to troubleshoot a
failure in the ARP resolution (for instance PC2 may be down and not responding to the FortiGate ARP requests).

FGT# diagnose sniffer packet any "host <PC1> or host <PC2> or arp" 4
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Debugging the packet flow

Traffic should come in and leave the VDOM. If you have determined that network traffic is not entering and
leaving the VDOM as expected, debug the packet flow.

Debugging can only be performed using CLI commands. Debugging the packet flow requires a number of debug
commands to be entered as each one configures part of the debug action, with the final command starting the
debug.

If your FortiGate unit has NP interfaces that are offloading traffic, this will change the
packet flow. Before performing the debug on any NP interfaces, you should disable
offloading on those interfaces.

The following configuration assumes that PC1 is connected to the internal interface of the FortiGate unit and has
an IP address of 10.11.101.200. PC1 is the host name of the computer.

To debug the packet flow in the CLI, enter the following commands:

FGT# diag debug enable
FGT# diag debug flow filter add <PC1>
FGT# diag debug flow show console enable
FGT# diag debug flow trace start 100
FGT# diag debug enable

The start 100 argument in the above list of commands will limit the output to 100 packets from the flow. This
is useful for looking at the flow without flooding your log or your display with too much information.

To stop all other debug activities, enter the command:

FGT# diag debug flow trace stop

The following is an example of debug flow output for traffic that has no matching Firewall Policy, and is in turn
blocked by the FortiGate unit. The denied message indicates the traffic was blocked. Note that even with VDOMs
not enabled, vd-root is still shown.

id=20085 trace_id=319 func=resolve_ip_tuple_fast line=2825 msg="vd-root received a
packet(proto=6, 192.168.129.136:2854->192.168.96.153:1863) from port3."

id=20085 trace_id=319 func=resolve_ip_tuple line=2924 msg="allocate a new session-
013004ac"

id=20085 trace_id=319 func=vf_ip4_route_input line=1597 msg="find a route: gw-
192.168.150.129 via port1"

id=20085 trace_id=319 func=fw_forward_handler line=248 msg=" Denied by forward policy
check"
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Chapter 33 - Virtual FortiOS

Virtual FortiOS

FortiGate virtual appliances allow you to mitigate blind spots by implementing critical security controls within your
virtual infrastructure. They also allow you to rapidly provision security infrastructure whenever and wherever it is
needed. FortiGate virtual appliances feature all of the security and networking services common to traditional
hardware-based FortiGate appliances. With the addition of virtual appliances from Fortinet, you can deploy a mix
of hardware and virtual appliances, operating together and managed from a common centralized management
platform.

Document scope
This document describes how to deploy a FortiGate virtual appliance in several virtualization server
environments. This includes how to configure the virtual hardware settings of the virtual appliance.

This document assumes:

l you have already successfully installed the virtualization server on the physical machine,
l you have installed appropriate VM management software on either the physical server or a computer to be used for

VM management.

This document does not cover configuration and operation of the virtual appliance after it has been successfully
installed and started. For these issues, see the FortiGate Handbook.

This document includes the following sections:

l Virtual FortiOSOverview
l Deployment example – VMware
l Deployment example – MSHyper-V
l Deployment example – KVM
l Deployment example – OpenXen
l Deployment example – Citrix XenServer

What's new in VM in 5.6

New Features in 5.6.6
More Azure SDN Connector settings including support for regions and AzureStack. See SDN Connector - Azure
(and AzureStack) on page 3420.
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New Features in 5.6.4
The following list contains new virtual FortiOS features added in FortiOS 5.6.4. Click on a link to navigate to that
section for further information.

l FortiGate VMX license status
l SDN connector addressing on page 3418
l Support for KVM-based hypervisor in AWS on page 3419
l HA support for GCP on page 3422
l Other Virtual FortiOS Products on page 3416

FortiGate VMX licence status

The VMX licence status is included in the output of get system status.

SDN connector addressing

When setting the address for an SDN connection, the value can be a fully qualified domain name (FQDN) as well
as an IP address. The setting that is currently called server was once called server-ip.

Support for KVM-based hypervisor in AWS

FortiGate-VM can be provisioned in AWSC5 instances on the marketplace (BYOL/OnDemand). These instances
are based on a home-brewed version of KVM that AWS started using. Systems deployed in C5 will see better
performance compared to C3/C4 instances. Deploying FortiGate-VM in these instances requires no configuration
on the part of the user.

HA support for GCP

FortiOS supports the use of active/passive HA, using a unicast heartbeat, in Google Cloud Platform (GCP) similar
to the HA support for Amazon Web Services (AWS).

HA support for Azure

FortiOS supports the use of active/passive HA, similar to that for Amazon Web Services (AWS) in an Azure
environment.

New Features in 5.6.0

FGT-VM VCPUs (308297)

Fortinet has now launched licensing for FortiGate VMs that support larger than 8 vCPUs. The new
models/licenses include:

l Support for up to 16 vCPU - FortiGate-VM16
l Support for up to 32 vCPU - FortiGate-VM32
l Support for unlimited vCPU - FortiGate-VMUL

Each of these models should be able to support up to 500 VDOMs.
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Improvements to License page (382128)

The page has been rewritten with some minor improvements such as:

l An indicator to show when a VM is waiting for authentication or starting up
l Shows VM status when license is valid
l Shows CLI console window when VM is waiting too long for remote registration of server

Citrix XenServer tools support for XenServer VMs (387984)

This support allows users, with Citrix XenServer tools to read performance statistics from XenServer clients and
do Xenmotion with servers in the same cluster

Since FortiGates don't support hardware hotplugging, the ability to do network
interface of disk changes is not supported at this time.

There are no changes to the GUI, but there are some changes to the CLI.

A setting has been edited to control the debug level of the XenServer tools daemon

diag debug application xstoolsd <integer>

Integer = Debug level

An additional update has been added to set the update frequency for XenServer tools

config system global
set xstools-update-frequency Xenserver <integer>
end

Enter an integer value from 30 to 300 (default = 60).

FOS VM supports more interfaces (393068)

The number of virtual interfaces that the VM version of FortiOS supports has been raised from 3 to 10.

NSX security group importing (403975)

A feature has been added to allow the importation of security group information from VMware's NSX firewall.

CLI Changes:

nsx group list

This is used to list NSX security Groups

Syntax:

execute nsx group list <name of the filter>

nsx group import

This is used to import NSX security groups.
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Syntax:

execute nsx group import <vdom> <name of the filter>

nsx group delete

This is used to delete NSX security Groups

Syntax:

execute nsx group delete <vdom> <name of the filter>

nsx.setting.update-period

This is used to set the update period for the NSX security group

Syntax:

config.nsx.setting.update-period <0 - 3600 in seconds>

0 means disabled

Default value: 0

Non-vdom VM models FGVM1V/FGVM2V/FGVM4V (405549)

Newmodels of the FortiGate-VM have been introduced. These match up with the existing FortiGate-VM models
of FG-VM01, FG-VM02 and FG-VM04. The difference being that the new models don't support VDOMs.

Original FortiGate-VM New FortiGate-VM without VDOM support

FG-VM01 FG-VM01v

FG-VM02 FG-VM02v

FG-VM04 FG-VM04v
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Virtual FortiOS Overview

The following topics are included in this section:

FortiGate VMmodels and licensing
Fortinet offers the FortiGate VM in five virtual appliance models determined by license. When configuring your
FortiGate VM, be sure to configure hardware settings within the ranges outlined below. Contact your Fortinet
Authorized Reseller for more information.

FortiGate VM model information

Technical Specification FG-VM00 FG-VM01 FG-VM02 FG-VM04 FG-VM08

Virtual CPUs
(min / max)

1 / 1 1 / 1 1 / 2 1 / 4 1 / 8

Virtual Network
Interfaces (min / max)

2 / 10

Virtual Memory
(min / max)

1GB /
2GB

1GB /
2GB

1GB /
4GB

1GB /
6GB

1GB
/12GB

Virtual Storage
(min / max)

32GB / 2TB

Managed Wireless APs
(tunnel mode / global)

32 / 32 32 / 64 256 / 512 256 / 512 1024 /
4096

Virtual Domains
(default / max)

1 / 2 10 / 10 10 / 25 10 / 50 10 / 250

There may be times the min/max values can change. An example for this is when the
maximum memory for FG-VM00 changed between 5.2 and 5.4 from 1 GB to 1.5 GM.
If that is the case, the settings for the VM will have to be manually changed to
accommodate the new parameters.

After placing an order for FortiGate VM, a license registration code is sent to the email address used on the order
form. Use the registration number provided to register the FortiGate VM with Customer Service & Support and
then download the license file. Once the license file is uploaded to the FortiGate VM and validated, your
FortiGate VM appliance is fully functional.

3411 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 33 - Virtual FortiOS Virtual FortiOSOverview

The number of Virtual Network Interfaces is not solely dependent on the FortiGate
VM. Some virtual environments have their own limitations on the number of interfaces
allowed. As an example, if you go to https://docs.microsoft.com/en-us/azure/virtual-
network/virtual-networks-multiple-nics, you will find that Azure has its own restrictions
for VMs, depending on the type of deployment or even the size of the VM.

FortiGate VM evaluation license

FortiGate VM includes a limited embedded 15-day trial license that supports:

l 1 CPUmaximum
l 1024 MBmemory maximum
l low encryption only (no HTTPS administrative access)
l all features except FortiGuard updates

You cannot upgrade the firmware, doing so will lock the Web-based Manager until a license is uploaded.
Technical support is not included. The trial period begins the first time you start FortiGate VM. After the trial
license expires, functionality is disabled until you upload a license file.

Registering FortiGate VM with Customer Service & Support
To obtain the FortiGate VM license file you must first register your FortiGate VM with Customer Service &
Support.

To register your FortiGate VM:

1. Log in to the Customer Service & Support portal using an existing support account or select Sign Up to create a
new account.

2. In the main page, underAsset, select Register/Renew.

The Registration page opens.
3. Enter the registration code that was emailed to you and select Register. A registration form will display.
4. After completing the form, a registration acknowledgement page will appear.
5. Select the License File Download link.
6. You will be prompted to save the license file (.lic) to your local computer. See "Upload the license file" for

instructions on uploading the license file to your FortiGate VM via the Web-based Manager.

Downloading the FortiGate VM deployment package
FortiGate VM deployment packages are included with FortiGate firmware images on the Customer Service &
Support site. First, see the following table to determine the appropriate VM deployment package for your VM
platform.
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Selecting the correct FortiGate VM deployment package for your VM platform

VM Platform FortiGate VM Deployment File

Citrix XenServer v5.6sp2, 6.0 and later FGT_VM64-v500-buildnnnn-FORTINET.
out.CitrixXen.zip

OpenXen v3.4.3, 4.1 FGT_VM64-v500-buildnnnn-FORTINET.
out.OpenXen.zip

Microsoft Hyper-V Server 2008R2 and 2012 FGT_VM64-v500-buildnnnn-FORTINET.
out.hyperv.zip

KVM (qemu 0.12.1) FGT_VM64-v500-buildnnnn-FORTINET.
out.kvm.zip

VMware ESX 4.0, 4.1
ESXi 4.0/4.1/5.0/5.1/5.5

FGT_VM32-v500-buildnnnn-FORTINET.
out.ovf.zip (32-bit)

FGT_VM64-v500-buildnnnn-FORTINET.
out.ovf.zip

For more information see the FortiGate product datasheet available on the Fortinet web site,
https://www.fortinet.com/content/dam/fortinet/assets/data-sheets/FortiGate_VM.pdf.

The firmware images FTP directory is organized by firmware version, major release, and patch release. The
firmware images in the directories follow a specific naming convention and each firmware image is specific to the
device model. For example, the FGT_VM32-v500-build0151-FORTINET.out.ovf.zip image found in the v5.0
Patch Release 2 directory is specific to the FortiGate VM 32-bit environment.

You can also download the FortiOS Release Notes, FORTINET-FORTIGATEMIB file,
FSSO images, and SSL VPN client in this directory. The Fortinet Core MIB file is
located in the main FortiGate v5.00 directory.

To download the FortiGate VM deployment package:

1. In the main page of the Customer Service & Support site, select Download > Firmware Images.

The Firmware Images page opens.
2. In the Firmware Images page, select FortiGate.
3. Browse to the appropriate directory on the FTP site for the version that you would like to download.
4. Download the appropriate .zip file for your VM server platform.

You can also download the FortiGate Release Notes.
5. Extract the contents of the deployment package to a new file folder.
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Deployment package contents

Citrix XenServer

The FORTINET.out.CitrixXen.zip file contains:

l fortios.vhd: the FortiGate VM system hard disk in VHD format
l fortios.xva: binary file containing virtual hardware configuration settings
l in the ovf folder:

l FortiGate-VM64.ovf: Open Virtualization Format (OVF) template file, containing virtual hardware settings for
Xen

l fortios.vmdk: the FortiGate VM system hard disk in VMDK format
l datadrive.vmdk: the FortiGate VM log disk in VMDK format

The ovf folder and its contents is an alternative method of installation to the .xva and VHD disk image.

OpenXEN

The FORTINET.out.OpenXen.zip file contains only fortios.qcow2, the FortiGate VM system hard disk in qcow2
format. You will need to manually:

l create a 32GB log disk
l specify the virtual hardware settings

Microsoft Hyper-V

The FORTINET.out.hyperv.zip file contains:

l in the Virtual Hard Disks folder:
l fortios.vhd: the FortiGate VM system hard disk in VHD format
l DATADRIVE.vhd: the FortiGate VM log disk in VHD format

l In the Virtual Machines folder:
l fortios.xml: XML file containing virtual hardware configuration settings for Hyper-V. This is compatible with

Windows Server 2012.
l Snapshots folder: optionally, Hyper-V stores snapshots of the FortiGate VM state here

KVM

The FORTINET.out.kvm.zip contains only fortios.qcow2, the FortiGate VM system hard disk in qcow2 format.
You will need to manually:

l create a 32GB log disk
l specify the virtual hardware settings

VMware ESX/ESXi

You will need to create a 32GB log disk.

The FORTINET.out.ovf.zip file contains:
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l fortios.vmdk: the FortiGate VM system hard disk in VMDK format
l datadrive.vmdk: the FortiGate VM log disk in VMDK format
l Open Virtualization Format (OVF) template files:

l FortiGate-VM64.ovf: OVF template based on Intel e1000 NIC driver
l FortiGate-VM64.hw04.ovf: OVF template file for older (v3.5) VMware ESX server
l FortiGate-VMxx.hw07_vmxnet2.ovf: OVF template file for VMware vmxnet2 driver
l FortiGate-VMxx.hw07_vmxnet3.ovf: OVF template file for VMware vmxnet3 driver

Use the VMXNET3 interface (FortiGate-VMxx.hw07_vmxnet3.ovf template) if
the virtual appliance will distribute workload to multiple processor cores.

Deploying the FortiGate VM appliance
Prior to deploying the FortiGate VM appliance, the VM platform must be installed and configured so that it is
ready to create virtual machines. The installation instructions for FortiGate VM assume that

l You are familiar with the management software and terminology of your VM platform.
l An Internet connection is available for FortiGate VM to contact FortiGuard to validate its license or, for closed

environments, a FortiManager can be contacted to validate the FortiGate VM license. See "Validate the FortiGate
VM license with FortiManager".

For assistance in deploying FortiGate VM, refer to the deployment chapter in this guide that corresponds to your
VMware environment. You might also need to refer to the documentation provided with your VM server. The
deployment chapters are presented as examples because for any particular VM server there are multiple ways to
create a virtual machine. There are command line tools, APIs, and even alternative graphical user interface tools.

Before you start your FortiGate VM appliance for the first time, you might need to adjust virtual disk sizes and
networking settings. The first time you start FortiGate VM, you will have access only through the console window
of your VM server environment. After you configure one FortiGate network interface with an IP address and
administrative access, you can access the FortiGate VM web-based manager.

After deployment and license validation, you can upgrade your FortiGate VM appliance’s firmware by
downloading either FGT_VM32-v500-buildnnnn-FORTINET.out (32-bit) or FGT_VM64-v500-buildnnnn-
FORTINET.out (64-bit) firmware. Firmware upgrading on a VM is very similar to upgrading firmware on a
hardware FortiGate unit.

FortiGate-VM is not part of the FortiGuard Network for the purpose of upgrades.

Performance and optimization
Performance is improved for FortiOS VM platforms by implementing features to improve efficiency and resource
utilization.
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Interrupt affinity

You can configure interrupt affinity and packet distribution to optimize performance for your VM environment.
Interrupt affinity allows you to align interrupts from interfaces to specific CPUs.

Configuring interrupt affinity

Use the following commands to configure interrupt affinity for two 10G interfaces (port2 and port3).

Interrupts from first interface are assigned to core #0 and those from the second interface are assigned to core
#1.

config system affinity-interrupt
edit 1

set interrupt "port2-TxRx-0"
set affinity-cpumask "0x1"

next
edit 2

set interrupt "port2-TxRx-1"
set affinity-cpumask "0x1"

next
edit 3

set interrupt "port3-TxRx-0"
set affinity-cpumask "0x2"

next
edit 4

set interrupt "port3-TxRx-1"
set affinity-cpumask "0x2"

end

Packet distribution

Packet distribution allows you to configure FortiGate-VM to distribute processing to multiple CPUs.Use the
following commands to configure packet redistribution to redistribute packets from core #0 and #1 to all other
cores.

Configuring packet distribution

The example is based on VM08:

config system affinity-packet-redistribution
edit 1

set interface "port2"
set affinity-cpumask "0xFC"

next
edit 2

set interface "port3"
set affinity-cpumask "0xFC"

end

Other Virtual FortiOS Products
Just like a VM installed on a platform located on a physical computer, these are instances of the FortiOS firmware
installed in virtual environments.
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SDN Environments

FortiOS-VM is now supported in a Number of SDN (Software Defined Network) environments through the use of a
SDN connector. The software can be found on the Fortinet Service and Support site. Documentation can be
found on the Fortinet Virtualization Documentation site.

The products include:

FortiGate-VMX

FortiOS On Demand

Connectors:

The SDN connectors provide integration and orchestration of Fortinet products with key SDN solutions. Fortinet
provides SDN connector support for public cloud connectors, such as VMware NSX, Cisco Application Centric
Infrastructure (ACI), and Nokia Nuage Virtualized Services Platform (VSP) . Fortinet also provides support for
private cloud connectors, such as Amazon Web Services and Microsoft Azure. You can configure SDN connectors
in the System > SDN Connectorsmenu.

Microsoft Azure only supports tag sets in Virtual Machines (VMs). You may only use
one Azure subscription ID and one Azure resource group. Only resources that are in
use by a running VM, such as a virtual network, subnet, or network security group, are
extracted.

FortiADC Connector for Cisco ACI

l Versions available:
l 1.0.0
l 1.2.0
l 1.3.0

FortiADC Connector for Cisco ACI

l Versions available:
l 1.0.0
l 1.2.0
l 1.3.0

FortiGate Connector for HPE VAN SDN

l Versions available:
l 1.0.5
l 1.1.0

FortiGate Connector for OpenStack ML2

l Versions available:
l 1.1

FortiManager Connector for Nuage Networks

l Versions available:
l 1.0
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Fortinet SDN Connector for Nuage VSP

Additional information relating to Connectors

While the product documentation concerns itself with the connector software, there is also settings within FortiOS
that relates to the usage of those connectors.

NSX Connector Support

There is support for NSX connector to upgrade to SDN connectors.

Change to config system sdn-connector:

config nsx setting

Change to config firewall address:

set type nsx

set type dynamic
set sdn nsx

When using the sdn nsx setting, the user should also use the nsx rest-api
password.

SDN connector addressing

When setting the address for an SDN connection, the value can be a fully qualified domain name (FQDN) as well
as an IP address. The setting that is currently called server was once called server-ip.

CLI

config system sdn-connector
edit <example>

set server [<ip address>|<fqdn address>]
end

Public Cloud Environments

Unlike SDNs where the user has administrative control over he virtual environment that the FortiOS is being
placed into, the Public Cloud services are run and managed by 3rd party companies with their own methods and
rules of provisioning that need to be followed to install the firmware into the environment.

Amazon Web Services (AWS)

Online documentation can be found at http://cookbook.fortinet.com/amazon-web-services-aws/

Additional information for AWS

While the online documentation is primarily for the installation of the FortiOS into the virtual environment,
periodically improvements are made to the firmware that affects its interaction with the environment but isn't
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really covered by installation instructions or information has changed in regards to those instructions but they may
not have all been updated yet.

Support for KVM-based hypervisor in AWS

FortiGate-VM can be provisioned in AWSC5 instances on the marketplace (BYOL/OnDemand). These instances
are based on a home-brewed version of KVM that AWS started using. Systems deployed in C5 will see better
performance compared to C3/C4 instances. Deploying FortiGate-VM in these instances requires no configuration
on the part of the user.

FortiGate-VM firmware can be placed in these instances because of:

l An NVME driver that is required to run C5 instances. It gets the correct partition name dependencies if an NVME
device is being used.

l Removing the xenstore checking requirement in the AWS setup daemon that is not required in non-Xen based
instances.

HA

AWS supports the use of HA.

This includes two parts:

1. HAwith unicast heartbeat traffic.
2. AWSAPI supports to move secondary IPs and update routing tables.

CLI:

Unicast HA config

config system ha
unicast-hb [enable|disable]
unicast-hb-peerip <Unicast Heartbeat Peer IP>
end

SDN Connector - AWS

SDN connectors can be configured in the GUI by going to System > SDN Connectors and choosing the
appropriate type to configure from the various virtual environments. AWS is supported in the GUI as well as the
CLI.

1. config aws setting has been moved to the context of config system sdn-connector.
config system sdn-connector

edit <string>
set access-key <AWS access key ID>
set secret-key <AWS secret access key>
set region <AWS region name>
set vpc-id <AWS VPC ID>
end

2. Update to the GUI SDN connector edit page that supports allowing configuration of the following fields:
l AWS access key ID
l AWS secret access key
l AWS region name
l AWSVPC ID
l Update Interval
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3. Change to address edit page to allow configuration of the Filter field for Dynamic AWS address.
4. Update to the dynamic address monitor API to get resolved address list for dynamic AWS addresses.

Azure

FortiOS supports the use of active/passive HA, similar to that for Amazon Web Services (AWS) in an Azure
environment.

SDN Connector - Azure (and AzureStack)

SDN connectors can be configured in the GUI by going to System > SDN Connectors and choosing the
appropriate type to configure from the various virtual environments. Azure is supported in the GUI as well as the
CLI. Azure connector options include the ability to select the region and the ability to configure Azure and
AzureStack fields such as the Azure tenant ID, client ID, subscription ID and resource group.

CLI options are available to configure with Azure:

l The system sdn-connector contains a connector type for Azure environments called azure.
l The nic option enables you to configure the Azure network interface.
l The route-table option enables you to configure the Azure route table.

Example:

config system sdn-connector
edit "azd"

set type azure
config nic

edit nic-eth2
config ip

edit ipconfig1
set public-ip p3

next
end

next
edit nic-eth3

config ip
edit ipconfig1

set public-ip p2
next

end
next

end
config route-table

edit 1
config route

edit 12
set next-hop 111.233.222.233

next
end

next
end

In addition to the options for HA already specified, there are settings specific to Azure connectivity within the
system sdn-connector context once the type has been set to azure.
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Option Description

tenant-id Azure tenant ID (directory ID).

subscription-
id Azure subscription ID.

client-id Azure client ID (application ID).

client-secret Azure client secret (application key).

resource-group Azure resource group.

azure-region Global/China Azure Region.

update-
interval

Dynamic object update interval in seconds (0 - 3600, 0 means disabled, default =
60).

Google Cloud Platform (GCP)

The following FortiGate-VM models will be supported on Google Cloud Platform:

l FG-VM01
l FG-VM02
l FG-VM04
l FG-VM08

FG-WM00 is not supported.

Since GCP use netmask 32, static route must be configured on GCP VPC, instead of FGT.

Licenses will be interchangeable between platforms. A FG-VM04 license that functions in a VMware or Citrix
environment can be also used in the GCP environment as well.

While an .out file will be necessary for upgrading, full downloadable images will not be needed for initial
installation of the solution. GCP consists of pre-existing images that can be checked out of their library and
deployed instantly. A difference between this environment and enterprise virtualization platforms is that machine
size can never change. An n1-standard-4 has exactly 15 GB of RAM and 4 vCPUs. This can never be changed or
edited by the end user or administrator.

The currently available GCP instances we are looking to support are as follows (these will/could change as vNIC
values reveal themselves):

FG-VM Equates to Instance Type vCPU RAM Disks

FG-VM01-GC n1-standard-1 1 3.75GB 16 (32 in Beta)

FG-VM02-GC n1-standard-2 2 7.50 GB 16 (64 in Beta)
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FG-VM Equates to Instance Type vCPU RAM Disks

FG-VM04-GC n1-standard-4 4 15 GB 16 (64 in Beta)

FG-VM08-GC n1-standard-8 8 30 GB 16 (128 in Beta)

FG-VM16-GC n1-standard-16 16 60 GB 16 (128 in Beta)

FG-VM32-GC n1-standard-32 32 88 GB 16 (128 in Beta)

FG-VMUL-GC any of the above and any new that could be created.

HA support for GCP

FortiOS supports the use of active/passive HA, using a unicast heartbeat, in Google Cloud Platform (GCP) similar
to the HA support for Amazon Web Services (AWS).

This support includes:

l HA in the same region within a project
l HA session and configuration synchronization
l Automatic failover to the passive unit (time dependant on configuration), using the built-in API call to GCP for

changing the routing path from the active unit to the passive unit.

There is a new connector type, gcp, that has been added to the type option for system sdn-connector as
well as a setting for the mask of the unicast heartbeat in system ha.

GCP type example:

config system sdn-connector
edit gcp

set type gcp
config external-ip

edit gundam-public
next

end
config route

edit gundam-route
next

end
next

end

Unicast example:

config system ha
set group-id 20
set group-name "cluster1"
set mode a-p
set hbdev "port3" 50
set ha-mgmt-status enable
config ha-mgmt-interfaces

edit 1
set interface "port4"
set gateway 172.16.100.1
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next
end
set override disable
set priority 20
set unicast-hb enable
set unicast-hb-peerip 172.16.201.3
set unicast-hb-netmask 255.255.255.0

end

Additional information from GCP: https://cloud.google.com/compute/docs/images/building-custom-os.
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Deployment example – VMware

Once you have downloaded the FGT_VMxx-v5-build0xxx-FORTINET.out.ovf.zip file from
http://support.fortinet.com and extracted the package contents to a folder on your local computer, you can use
the vSphere client to create the virtual machine from the deployment package OVF template.

The following topics are included in this section:

Open the FortiGate VM OVF file with the vSphere client

To deploy the FortiGate VM OVF template:

1. Launch the VMware vSphere client, enter the IP address or host name of your server, enter your user name and
password and select Login.

The vSphere client home page opens.

2. Select File > Deploy OVF Template to launch the OVF Template wizard.

The OVF Template Source page opens.
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3. Select the source location of the OVF file. Select Browse and locate the OVF file on your computer. Select Next
to continue.

The OVF Template Details page opens.

4. Verify the OVF template details. This page details the product name, download size, size on disk, and description.
Select Next to continue.
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The OVF Template End User License Agreement page opens.

5. Read the end user license agreement for FortiGate VM. Select Accept and then select Next to continue.
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The OVF Template Name and Location page opens.

6. Enter a name for this OVF template. The name can contain up to 80 characters and it must be unique within the
inventory folder. Select Next to continue.
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The OVF Template Disk Format page opens.

7. Select one of the following:
l Thick Provision Lazy Zeroed: Allocates the disk space statically (no other volumes can take the space), but

does not write zeros to the blocks until the first write takes place to that block during runtime (which includes a
full disk format).

l Thick Provision Eager Zeroed: Allocates the disk space statically (no other volumes can take the space),
and writes zeros to all the blocks.

l Thin Provision: Allocates the disk space only when a write occurs to a block, but the total volume size is
reported by VMFS to the OS. Other volumes can take the remaining space. This allows you to float space
between your servers, and expand your storage when your size monitoring indicates there is a problem. Note
that once a Thin Provisioned block is allocated, it remains on the volume regardless if you have deleted data,
etc.

8. Select Next to continue.

The OVF Template Network Mapping page opens.
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9. Map the networks used in this OVF template to networks in your inventory. Network 1 maps to port1 of the
FortiGate VM. You must set the destination network for this entry to access the device console. Select Next to
continue.

The OVF Template Ready to Complete page opens.
10. Review the template configuration. Make sure that Power on after deployment is not enabled. You might need

to configure the FortiGate VM hardware settings prior to powering on the FortiGate VM.
11. Select Finish to deploy the OVF template. You will receive a Deployment Completed Successfully dialog box

once the FortiGate VM OVF template wizard has finished.

Configure FortiGate VM hardware settings
Before powering on your FortiGate VM you must configure the virtual memory, virtual CPU, and virtual disk
configuration to match your FortiGate VM license.

3429 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 33 - Virtual FortiOS Deployment example – VMware

Transparent mode VMware configuration
If you want to use your FortiGate-VM in transparent mode, your VMware server’s virtual switches must operate in
promiscuous mode. This permits these interfaces to receive traffic that will pass through the FortiGate unit but
was not addressed to the FortiGate unit.

In VMware, promiscuous mode must be explicitly enabled:

1. In the vSphere client, select your VMware server in the left pane and then select the Configuration tab in the
right pane.

2. In Hardware, select Networking.
3. Select Properties of vSwitch0.
4. In the Propertieswindow left pane, select vSwitch and then select Edit.
5. Select the Security tab, set Promiscuous Mode to Accept, then select OK.
6. Select Close.
7. Repeat steps 3 through 6 for other vSwitches that your transparent mode FortiGate-VM uses.

High Availability VMware configuration
If you want to combine two or more FortiGate-VM instances into a FortiGate Clustering Protocol (FGCP) High
Availability (HA) cluster the VMware server’s virtual switches used to connect the heartbeat interfaces must
operate in promiscuous mode. This permits HA heartbeat communication between the heartbeat interfaces. HA
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heartbeat packets are non-TCP packets that use Ethertype values 0x8890, 0x8891, and 0x8890. The FGCP uses
link-local IPv4 addresses in the 169.254.0.x range for HA heartbeat interface IP addresses.

To enable promiscuous mode in VMware:

1. In the vSphere client, select your VMware server in the left pane and then select the Configuration tab in the
right pane.

2. In Hardware, select Networking.
3. Select Properties of a virtual switch used to connect heartbeat interfaces.
4. In the Propertieswindow left pane, select vSwitch and then select Edit.
5. Select the Security tab, set Promiscuous Mode to Accept, then select OK.
6. Select Close.

You must also set the virtual switches connected to other FortiGate interfaces to allow MAC address changes and
to accept forged transmits. This is required because the FGCP sets virtual MAC addresses for all FortiGate
interfaces and the same interfaces on the different VM instances in the cluster will have the same virtual MAC
addresses.

To make the required changes in VMware:

1. In the vSphere client, select your VMware server in the left pane and then select the Configuration tab in the
right pane.

2. In Hardware, select Networking.
3. Select Properties of a virtual switch used to connect FortiGate VM interfaces.
4. SetMAC Address ChangestoAccept.
5. Set Forged Transmits to Accept.

Power on your FortiGate VM
You can now proceed to power on your FortiGate VM. There are several ways to do this:

l Select the name of the FortiGate VM you deployed in the inventory list and select Power on the virtual machine
in theGetting Started tab.

l In the inventory list, right-click the name of the FortiGate VM you deployed, and select Power > Power On.
l Select the name of the FortiGate VM you deployed in the inventory list. Click the Power On button on the toolbar.

Select the Console tab to view the console. To enter text, you must click in the console pane. The mouse is then
captured and cannot leave the console screen. As the FortiGate console is text-only, no mouse pointer is visible.
To release the mouse, press Ctrl-Alt.
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Deployment example – MS Hyper-V

Once you have downloaded the FGT_VMxx_HV-v5-build0xxx-FORTINET.out.hyperv.zip file and extracted the
package contents to a folder on your Microsoft server, you can deploy the VHD package to your Microsoft Hyper-V
environment.

The following topics are included in this section:

Create the FortiGate VM virtual machine

To create the FortiGate VM virtual machine:

1. Launch the Hyper-VManager in your Microsoft server.

The Hyper-V Manager home page opens.
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2. Select the server in the right-tree menu. The server details page is displayed.

3. Right-click the server and select New and select Virtual Machine from the menu. Optionally, in the Actions
menu, select New and select Virtual Machine from the menu.
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The New Virtual Machine Wizard opens.

4. Select Next to create a virtual machine with a custom configuration.

The Specify Name and Location page is displayed.
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5. Enter a name for this virtual machine. The name is displayed in the Hyper-VManager.
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Select Next to continue. The Assign Memory page is displayed.

6. Specify the amount of memory to allocate to this virtual machine. The default memory for FortiGate VM is 1GB
(1024MB).
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Select Next to continue. The Configure Networking page is displayed.

7. Each new virtual machine includes a network adapter. You can configure the network adapter to use a virtual
switch, or it can remain disconnected. FortiGate VM requires four network adapters. You must configure network
adapters in the Settings page.

Select Next to continue. The Connect Virtual Hard Disk page is displayed.
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8. Select to use an existing virtual hard disk and browse for the fortios.vhd file that you downloaded from the
Fortinet Customer Service & Support portal.
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Select Next to continue. The Summary page is displayed.

9. To create the virtual machine and close the wizard, select Finish.

Configure FortiGate VM hardware settings
Before powering on your FortiGate VM you must configure the virtual memory, virtual CPU, and virtual disk
configuration to match your FortiGate VM license.

To configure settings for FortiGate VM on the server:

1. In the Hyper-VManager, locate the name of the virtual machine, right-click the entry, and select Settings from
the menu. Optionally, you can select the virtual machine and select Settings in the Actionsmenu.
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The Settings page is displayed.
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2. Configure virtual processors, network adapters, and virtual hard drive settings.
3. Select Apply to save the settings and then select OK to close the settings page.

FortiGate VM virtual processors

You must configure FortiGate VM virtual processors in the server settings page. The number of processors is
dependent on your server environment.

Configure FortiGate VM virtual processors:

1. In the Settings page, select Processor from the Hardwaremenu.

The Processor page is displayed.
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2. Configure the number of virtual processors for the FortiGate VM virtual machine. Optionally, you can use resource
controls to balance resources among virtual machines.

3. Select Apply to save the settings.

FortiGate VM network adapters

You must configure FortiGate VM network adapters in the server settings page. FortiGate VM supports four
network adapters.

Configure FortiGate VM network adapters:

1. In the Settings page, select Add Hardware from the Hardwaremenu, select Network Adapter in the device
list, and select the Add button.
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The Network Adapter page is displayed.

1. You must manually configure four network adapters for FortiGate VM in the settings page. For each network
adapter, select the virtual switch from the drop-down list.

2. Select Apply to save the settings.

FortiGate VM virtual hard disk

You must configure the FortiGate VM virtual hard disk in the server settings page.

If you know your environment will expand in the future, it is recommended to increase the hard disk size beyond
30GB. The VM license limit is 2TB.

Configure a FortiGate VM virtual hard drive:

1. In the Settings page, select IDE Controller 0 > Hard Drive from the Hardwaremenu.

The Hard Drive page is displayed.
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2. Select New to create a new virtual hard disk.
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The New Virtual Hard Disk Wizard opens.

3. This wizard helps you to create a new virtual hard disk.
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Select Next to continue. The Choose Disk Format page opens.

4. Select to use VHDX format virtual hard disks. This format supports virtual disks up to 64TB and is resilient to
consistency issues that might occur from power failures. This format is not supported in operating systems earlier
than Windows Server 2012. Note that FortiGate-VM does not support hard disks larger than 2TB.
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Select Next to continue. The Choose Disk Type page opens.

5. Select the type of virtual disk you want to use. Select one of the following disk types:
l Fixed size: This type of disk provides better performance and is recommended for servers running applications

with high levels of disk activity. The virtual hard disk file that is created initially uses the size of the virtual hard
disk and does not change when data is deleted or added.

l Dynamic expanding: This type of disk provides better use of physical storage space and is recommended for
servers running applications that are not disk intensive. The virtual disk file that is created is small initially and
changes as data is added.

l Differencing: This type of disk is associated in a parent-child relationship with another disk that you want to
leave intact. You can make changes to the data or operating system without affecting the parent disk, so that
you can revert the changes easily. All children must have the same virtual hard disk format as the parent (VHD
or VHDX).

Select Next to continue. The Specify Name and Location page opens.
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6. Specify the name and location of the virtual hard disk file. Use the Browse button to select a specific file folder on
your server.

Select Next to continue. The Configure Disk page opens.
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7. Select to Create a new blank virtual hard disk and enter the size of the disk in GB. The maximum size is
dependent on your server environment.
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Select Next to continue. The Summary page opens.

8. The summary page provides details of the virtual hard disk. Select Finish to create the virtual hard disk.
9. Select Apply to save the settings and select OK to exit the settings page.

High Availability Hyper-V configuration
Promiscuous mode and support for MAC address spoofing is required for FortiGate-VM for Hyper-V to support
FortiGate Clustering Protocol (FGCP) high availability (HA). By default the FortiGate-VM for Hyper-V has
promiscuous mode enabled in the XML configuration file in the FortiGate-VM Hyper-V image. If you have
problems with HAmode, confirm that this is still enabled.

In addition, because the FGCP applies virtual MAC addresses to FortiGate data interfaces and because these
virtual MAC addresses mean that matching interfaces of different FortiGate-VM instances will have the same
virtual MAC addresses you have to configure Hyper-V to allow MAC spoofing. But you should only enable MAC
spoofing for FortiGate-VM data interfaces. You should not enable MAC spoofing for FortiGate HA heartbeat
interfaces.

With promiscuous mode enabled and the correct MAC spoofing settings you should be able to configure HA
between two or more FortiGate-VM for Hyper-V instances.
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Start the FortiGate VM
You can now proceed to power on your FortiGate VM. Select the name of the FortiGate VM in the list of virtual
machines, right-click, and select Start in the menu. Optionally, you can select the name of the FortiGate VM in
the list of virtual machines and select Start in the Actionsmenu.
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Deployment example – KVM

Once you have downloaded the FORTINET.out.kvm.zip file and extracted virtual hard drive image file
fortios.qcow2, you can create the virtual machine in your KVM environment.

The following topics are included in this section:

Create the FortiGate VM virtual machine

To create the FortiGate VM virtual machine:

1. Launch Virtual Machine Manager (virt-manager) on your KVM host server.

The Virtual Machine Manager home page opens.
2. In the toolbar, select Create a new virtual machine.

3. Enter a Name for the VM, FGT-VM for example.
4. Ensure that Connection is localhost. (This is the default.)
5. Select Import existing disk image.
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6. Select Forward.

7. InOS Type select Linux.
8. In Version, select a Generic version with virtio.
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9. Select Browse.

10. If you copied the fortios.qcow2 file to /var/lib/libvirt/images, it will be visible on the right. If you saved it
somewhere else on your server, select Browse Local and find it.

11. Choose Choose Volume.
12. Select Forward.
13. Specify the amount of memory and number of CPUs to allocate to this virtual machine. The amounts must not

exceed your license limits. See Virtual FortiOSOverview on page 3411.
14. Select Forward.
15. Expand Advanced options. A new virtual machine includes one network adapter by default. Select a network

adapter on the host computer. Optionally, set a specific MAC address for the virtual network interface. Set Virt
Type to virtio and Architecture to qcow2.

16. Select Finish.

Configure FortiGate VM hardware settings
Before powering on your FortiGate VM you must add the log disk and configure the virtual hardware of your
FortiGate VM.

To configure settings for FortiGate VM on the server:

1. In the Virtual Machine Manager, locate the name of the virtual machine and then select Open from the toolbar.
2. Select Add Hardware. In the Add Hardwarewindow select Storage.
3. Select Create a disk image on the computer’s harddrive and set the size to 30GB.
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If you know your environment will expand in the future, it is recommended to increase
the hard disk size beyond 30GB. The VM license limit is 2TB.

4. Enter:

Device type Virtio disk

Cache mode Default

Storage format raw

Even though raw is the storage format listed, the qcow2 format is also supported.

5. Select Network to configure add more the network interfaces. The Device typemust be Virtio.

A new virtual machine includes one network adapter by default. You can add more through the Add Hardware
window. FortiGate VM requires four network adapters. You can configure network adapters to connect to a virtual
switch or to network adapters on the host computer.

6. Select Finish.

Start the FortiGate VM
You can now proceed to power on your FortiGate VM. Select the name of the FortiGate VM in the list of virtual
machines. In the toolbar, select Console and then select Start.
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Deployment example – OpenXen

Once you have downloaded the FORTINET.out.OpenXen.zip file and extracted virtual hard drive image file
fortios.qcow2, you can create the virtual machine in your OpenXen environment.

The following topics are included in this section:

Create the FortiGate VM virtual machine (VMM)

To create the FortiGate VM virtual machine:

1. Launch Virtual Machine Manager (virt-manager) on your OpenXen host server.

The Virtual Machine Manager home page opens.
2. In the toolbar, select Create a new virtual machine.

3. Enter a Name for the VM, FGT-VM for example.
4. Ensure that Connection is localhost. (This is the default.)
5. Select Import existing disk image.
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6. Select Forward.

7. InOS Type select Linux.
8. In Version, select Generic 2.4.x.kernel.
9. Select Browse.

The Locate or create storage volumewindow opens.
10. Select Browse Local, find the fortios.qcow2 disk image file.
11. Select fortios.qcow2 and select Choose Volume.
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12. Select Forward.

13. Specify the amount of memory and number of CPUs to allocate to this virtual machine. The amounts must not
exceed your license limits.
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14. Select Forward.

15. Select Customize configuration before install. This enables you to make some hardware configuration
changes before VM creation is started.

16. Expand Advanced options. A new virtual machine includes one network adapter by default. Select Specify
shared device name and enter the name of the bridge interface on the OpenXen host. Optionally, set a specific
MAC address for the virtual network interface. Virt Type and Architecture are set by default and should be
correct.

17. Select Finish.

The virtual machine hardware configuration window opens.
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You can use this window to add hardware such as network interfaces and disk drives.
18. Select Add Hardware. In the Add Hardwarewindow select Storage.
19. Select Create a disk image on the computer’s harddrive and set the size to 30GB.

If you know your environment will expand in the future, it is recommended to increase
the hard disk size beyond 30GB. The VM license limit is 2TB.

20. Enter:

Device type Virtio disk

Cache mode Default

Storage format raw

21. Select Network to configure add more the network interfaces. The Device typemust be Virtio.

A new virtual machine includes one network adapter by default. You can add more through the Add Hardware
window. FortiGate VM requires four network adapters. You can configure network adapters to connect to a virtual
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switch or to network adapters on the host computer.
22. Select Finish.
23. Select Begin Installation. After the installation completes successfully, the VM starts and the console window

opens.
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Deployment example – Citrix XenServer

Once you have downloaded the FORTINET.out.CitrixXen.zip file and extracted the files, you can create the
virtual machine in your Citrix Xen environment.

The following topics are included in this section:

Create the FortiGate VM virtual machine (XenCenter)

To create the FortiGate VM virtual machine from the OVF file

1. Launch XenCenter on your management computer.

The management computer can be any computer that can run Citrix XenCenter, a Windows application.
2. If you have not already done so, select ADD a server. Enter your Citrix XenServer IP address and the root logon

credentials required to manage that server.

Your Citrix XenServer is added to the list in the left pane.

The Virtual Machine Manager home page opens.
3. Go to File > Import. An import dialog will appear.
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4. Click the Browse button, find the FortiGate-VM64-Xen.ovf template file, then clickOpen.

5. Select Next.
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6. Accept the FortiGate Virtual Appliance EULA, then select Next.

7. Choose the pool or standalone server that will host the VM, then select Next.
8. Select the storage location for FortiGate VM disk drives or accept the default. Select Next.
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9. Configure how each vNIC (virtual network adapter) in FortiGate VM will be mapped to each vNetwork on the Citrix
XenServer, then clickNext.

10. ClickNext to skip OS fixup.
11. Select Next to use the default network settings for transferring the VM to the host.
12. Select Finish.

The Citrix XenServer imports the FortiGate VM files and configures the VM as specified in the OVF template.
Depending on your computer’s hardware speed and resource load, and also on the file size and speed of the
network connection, this might take several minutes to complete.

When VM import is complete, the XenCenter left pane includes the FortiGate VM in the list of deployed VMs for
your Citrix XenServer.

Configure virtual hardware
Before you start your FortiGate-VM for the first time, you need to adjust your virtual machine’s virtual hardware
settings to meet your network requirements.
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Configuring number of CPUs and memory size

Your FortiGate-VM license limits the number CPUs and amount of memory that you can use. The amounts you
allocate must not exceed your license limits.

To access virtual machine settings

1. Open XenCenter.
2. Select your FortiGate VM in the left pane.

The tabs in the right pane provide access to the virtual hardware configuration. The Console tab provides access
to the FortiGate console.

1. To set the number of CPUs
2. In the XenCenter left pane, right-click the FortiGate VM and select Properties.

The Properties window opens.
3. In the left pane, select CPU.

4. Adjust Number of CPUs and then select OK.

XenCenter will warn if you select more CPUs than the Xen host computer contains. Such a configuration might
reduce performance.

To set memory size

1. In the XenCenter left pane, select the FortiGate VM.
2. In the right pane, select theMemory tab.
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3. Select Edit, modify the value in the Set a fixed memory of field and select OK.

Configuring disk storage

By default the FortiGate VM data disk 30GB. You will probably want to increase this. Disk resizing must be done
before you start the VM for the first time.

To resize the FortiGate data disk

1. In the XenCenter left pane, select the FortiGate VM.
2. Select the Storage tab. Select Hard disk 2 (the 30GB drive), then select Properties.

The ‘Hard disk 2’ Propertieswindow opens.
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3. Select Size and Location. Adjust Size and select OK.
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FortiGate VM Initial Configuration

Before you can connect to the FortiGate VM web-based manager you must configure a network interface in the
FortiGate VM console. Once an interface with administrative access is configured, you can connect to the
FortiGate VM web-based Manager and upload the FortiGate VM license file that you downloaded from the
Customer Service & Support website.

The following topics are included in this section:

Set FortiGate VM port1 IP address
Hypervisor management environments include a guest console window. On the FortiGate VM, this provides
access to the FortiGate console, equivalent to the console port on a hardware FortiGate unit. Before you can
access the Web-based manager, you must configure FortiGate VM port1 with an IP address and administrative
access.
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To configure the port1 IP address:

1. In your hypervisor manager, start the FortiGate VM and access the console window.
You might need to press Return to see a login prompt.

Example of FortiGate VM console access:

2. At the FortiGate VM login prompt enter the username admin. By default there is no password. Just press Return.
3. Using CLI commands, configure the port1 IP address and netmask. Also, HTTP access must be enabled because

until it is licensed the FortiGate VM supports only low-strength encryption. HTTPS access will not work.

For example:
config system interface

edit port1
set ip 192.168.0.100 255.255.255.0
append allowaccess http

end

You can also use the append allowaccess CLI command to enable other access
protocols, such as auto-ipsec, http, probe-response, radius-acct, snmp,
and telnet. The ping, https, ssh, and fgfm protocols are enabled on the
port1 interface by default.
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4. To configure the default gateway, enter the following CLI commands:
config router static

edit 1
set device port1
set gateway <class_ip>

end

You must configure the default gateway with an IPv4 address. FortiGate VM needs to
access the Internet to contact the FortiGuard Distribution Network (FDN) to validate its
license.

5. To configure your DNS servers, enter the following CLI commands:
config system dns

set primary <Primary DNS server>
set secondary <Secondary DNS server>

end

The default DNS servers are 208.91.112.53 and 208.91.112.52.

6. To upload the FortiGate VM license from an FTP or TFTP server, use the following CLI command:
execute restore vmlicense {ftp | tftp} <VM license file name> <Server IP or FQDN>

[:server port]

You can also upload the license in the FortiGate VM Web-based Manager. See Set
FortiGate VM port1 IP address on page 3469.
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Web-based Manager and Evaluation License dialog box

Connect to the FortiGate VMWeb-based Manager
When you have configured the port1 IP address and netmask, launch a web browser and enter the IP address
that you configured for port1. At the login page, enter the username admin and password field and select Login.
The default password is no password. The Web-based Manager will appear with an Evaluation License dialog
box.

Due to low encryption on the FortiGate side of the connection, some
modern browsers will not allow the connection. If that is the case, the
adjusting of the browser settings is unlikely to make a difference. There are
two options:

l Use FTP or TFTP to apply the license
l Make sure that the interface on the port being accessed has been configured

to allow HTTP/HTTPS access

Upload the FortiGate VM license file
Every Fortinet VM includes a 15-day trial license. During this time the FortiGate VM operates in evaluation mode.
Before using the FortiGate VM you must enter the license file that you downloaded from the Customer Service &
Support website upon registration.

GUI

To upload the FortiGate VM licence file:

1. There are 2 ways to get to the License upload window.
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i. In the Dashboard > Main window, in the Virtual Machinewidget, left click on the FGVMEV (FortiGate-
VM Evaluation) License icon. This will reveal a menu of selections to take you to directly to the FortiGate
VM Licensewindow or to the FortiGuard Detailswindow.

ii. Go to System > FortiGuard. In the Licence Information section, go to the Virtual Machine row and
click on the link to FortiGate VM License.

2. In the Evaluation License dialog box, select Enter License.
The license upload page opens.

License upload page:

3. Select Upload and locate the license file (.lic) on your computer. Select OK to upload the license file.
4. Refresh the browser to login.
5. Enter admin in the Name field and select Login. The VM registration status appears as valid in the License

Information widget once the license has been validated by the FortiGuard Distribution Network (FDN) or
FortiManager for closed networks.

Modern browsers can have an issue with allowing connecting to a FortiGate if the
encryption on the device is too low. Adjusting browser settings does not normally
mitigate the issue. If this happens, Admins must use a FTP/TFTP server to apply the
license.

CLI

You can also upload the license file via the CLI using the following CLI command:

execute restore vmlicense [ftp | tftp] <filenmame string> <ftp server>[:ftp port]

Example:

The following is an example output when using a tftp server to install license.

exec restore vmlicense tftp license.lic 10.0.1.2
This operation will overwrite the current VM license!Do you want to continue? (y/n)y
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Please wait...Connect to tftp server 10.0.1.2 ...
Get VM license from tftp server OK.
VM license install succeeded.
Rebooting firewall.

The command has the side effect of rebooting the firewall without giving you a chance
to back out or delay the reboot, so becareful about the timing of using the command.

Validate the FortiGate VM license with FortiManager
You can validate your FortiGate VM license with some models of FortiManager. To determine whether your
FortiManager unit has the VM Activation feature, see Features section of the FortiManager Product Data sheet.

To validate your FortiGate VM with your FortiManager:

1. To configure your FortiManager as a closed network, enter the following CLI command on your FortiManager:
config fmupdate publicnetwork

set status disable
end

2. To configure FortiGate VM to use FortiManager as its override server, enter the following CLI commands on your
FortiGate VM:
config system central-management

set mode normal
set type fortimanager
set fmg <IPv4 address of the FortiManager device>
set fmg-source-ip <Source IPv4 address when connecting to the FortiManager device>
set include-default-servers disable
set vdom <Enter the name of the VDOM to use when communicating with the FortiManager

device>
end

3. Load the FortiGate VM license file in the Web-based Manager. Go to System > Dashboard > Status. In the
License Information widget, in the Registration Status field, select Update. Browse for the .lic license file
and select OK.

4. To activate the FortiGate VM license, enter the following CLI command on your FortiGate VM:
execute update-now

5. To check the FortiGate VM license status, enter the following CLI commands on your FortiGate VM:
get system status

The following output is displayed:

Version: Fortigate-VM v5.0,build0099,120910 (Interim)
Virus-DB: 15.00361(2011-08-24 17:17)
Extended DB: 15.00000(2011-08-24 17:09)
Extreme DB: 14.00000(2011-08-24 17:10)
IPS-DB: 3.00224(2011-10-28 16:39)
FortiClient application signature package: 1.456(2012-01-17 18:27)
Serial-Number: FGVM02Q105060000
License Status: Valid
BIOS version: 04000002
Log hard disk: Available
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Hostname: Fortigate-VM
Operation Mode: NAT
Current virtual domain: root
Max number of virtual domains: 10
Virtual domains status: 1 in NAT mode, 0 in TP mode
Virtual domain configuration: disable
FIPS-CC mode: disable
Current HA mode: standalone
Distribution: International
Branch point: 511
Release Version Information: MR3 Patch 4
System time: Wed Jan 18 11:24:34 2012

diagnose hardware sysinfo vm full
The following output is displayed:

UUID: 564db33a29519f6b1025bf8539a41e92
valid: 1
status: 1
code: 200 (If the license is a duplicate, code 401 will be displayed)
warn: 0
copy: 0
received: 45438
warning: 0
recv: 201201201918
dup:

Licensing timeout

In closed environments without Internet access, it is mandatory to perform offline licensing of the virtual
FortiGate using a FortiManager as a license server. If the FortiGate-VM cannot perform license validation within
the license timeout period, which is 30 days, the FortiGate will discard all packets and effectively ceasing
operation as a firewall.

The status of the licence will go through some status changes before it times out.

Status Description

Valid The FortiGate can connect and validate against a FortiManager or FDS

Warning
The FortiGate cannot connect and validate against a FortiManager or FDS. A check is made
against how many days the Warning status has been continuous. If the number is less the 30
days the status does not change.

Invalid The FortiGate cannot connect and validate against a FortiManager or FDS. A check is made
against how many days the Warning status has been continuous. If the number is 30 days or
more, the status changes to Invalid.The firewall ceases to function properly.

There is only a single log entry after the virtual FortiGate cannot access the license
server for the license expiration period. This means that when you go searching the
logs for a reason for the FortiGate being offline there will not be a long list of error logs
that draw attention to the issue. There will only be the one entry.
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Revalidation

To restore validation of the licence, reestablish connectivity to the Internet. The VM licences is automatically
revalidated after access to the Internet is restored.

Configure your FortiGate VM
Once the FortiGate VM license has been validated you can begin to configure your device. You can use the
Wizard located in the top toolbar for basic configuration including enabling central management, setting the
admin password, setting the time zone, and port configuration.
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Chapter 34 - VoIP Solutions: SIP

VoIP solutions: SIP

This FortiOS Handbook chapter contains detailed information about how FortiGates processes SIP VoIP calls
and how to configure the FortiGate to apply security features to SIP calls. This document describes all FortiGate
SIP configuration options and contains detailed configuration examples.

This document uses numeric IP addresses for all SIP end points. SIP addresses can
also use domain names instead of addresses. For the example, the following SIP
addresses could refer to the same SIP end point:

inviter@10.31.101.20
inviter@example.com

Before you begin
Before you begin to configure VoIP security profiles, including SIP, from the GUI you should go to System
> Feature Visibility and turn on VoIP (underAdditional Features).

Also, VoIP settings are only available if the FortiGate or current VDOM Inspection Mode is set to Proxy. To
view the inspection mode go to System > Settings to confirm that Inspection Mode is set to Proxy. You can
also use the following CLI command to change the inspection mode to proxy:

config system settings
set inspection-mode proxy

end

The System Information dashboard widget also shows the current Mode.

How this guide is organized
This FortiOS Handbook chapter contains the following sections:

Inside FortiOS: VoIP Protection introduces FortiOS VoIP Protection

FortiGate VoIP solutions: SIP introduces FortiGate SIP support.

Common SIP VoIP configurations describes some common SIP configurations.

SIPmessages and media protocols describes SIP messages and some common SIPmedia protocols.

The SIP session helper describes how the SIP session helper works and how to configure SIP support using the
SIP session helper.

The SIP ALG describes how the SIP Application Layer Gateway (ALG) works and how to configure SIP support
using the SIP ALG.

Conflicts between the SIP ALG and the session helper describes how to sort out conflicts between the SIP
session helper and the ALG.
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Stateful SIP tracking, call termination, and session inactivity timeout describes how the SIP ALG performs SIP
stateful tracking, call termination and session actitivity timeouts.

SIP and RTP/RTCP describes how SIP relates to RTP and RTCP.

How the SIP ALG creates RTP pinholes describes how the SIP ALG creates pinholes.

Configuration example: SIP in Transparent Mode describes how to configure a FortiGate in Transparent mode to
support SIP.

RTP enable/disable (RTP bypass) describes RTP bypass.

Opening and closing SIP register, contact, via and record-route pinholes describes how FortiOS opens and closes
these pinholes.

Accepting SIP register responses describes how to enable accepting SIP register responses.

How the SIP ALG performs NAT describes how the SIP ALG performs NAT.

Enhancing SIP pinhole security describes how to open smaller pinholes.

Hosted NAT traversal describes SIP hosted NAT traversal and how to configure it.

SIP over IPv6 describes how to configure SIP over IPv6.

Deep SIPmessage inspection describes how deep SIP message inspection works.

Blocking SIP request messages describes how to block SIP request messages to prevent some common SIP
attacks.

SIP rate limiting includes more options for preventing SIP attacks.

SIP logging describes how to enable SIP logging.

Inspecting SIP over SSL/TLS (secure SIP) describes how to inspection encrypted SIP traffic.

SIP and HA–session failover and geographic redundancy describes how to use FGCPHA to support
SIP geographic redundancy.

SIP and IPS describes how to turn on IPS for SIP sessions.

SIP debugging describes some tools for debugging your SIP configuration.

FortiOS 5.6 VoIP new features
FortiOS 5.6 includes the following new VoIP and SIP features:

SIP strict-register enabled by default in VoIP Profiles (380830)

If strict-register is disabled, when REGISTER is received by a FortiGate, the source address (usually the
IP address of PBX) and ports (usually port 5060) are translated by NAT to the external address of the FortiGate
and port 65476. Pinholes are then opened for SIP and RTP. This tells the SIP provider to send incoming SIP
traffic to the external address of the FortiGate on port 65476.

This creates a security hole since the port is open regardless of the source IP address so an attacker who scans all
the ports by sending REGISTERmessages to the external IP of the FortiGate will eventually have one register go
through.
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When strict-register is enabled (the new default) the pinhole is smaller because it will only accept packets
from the SIP server.

Enabling strict-register can cause problems when the SIP registrar and SIP proxy server are separate
entities with separate IP addresses.

SIP diagnose command improvements (376853)

A diagnose command has been added to the CLI that outputs VDOM data located in the voipd daemon.

diagnose sys sip-proxy vdom

Example

(global) # diagnose sys sip-proxy vdom
VDOM list by id:
vdom 0 root (Kernel: root)
vdom 1 dmgmt-vdom (Kernel: dmgmt-vdom)
vdom 2 test2 (Kernel: test2)
vdom 3 test3 (Kernel: test3)
vdom 4 vdoma2 (Kernel: vdoma2)
vdom 5 vdomb2 (Kernel: vdomb2)
vdom 6 vdomc2 (Kernel: vdomc2)
vdom 7 vdoma (Kernel: vdoma)
vdom 8 vdomb (Kernel: vdomb)
vdom 9 vdomc (Kernel: vdomc)
VDOM list by name:
vdom 1 dmgmt-vdom (Kernel: dmgmt-vdom)
vdom 0 root (Kernel: root)
vdom 2 test2 (Kernel: test2)
vdom 3 test3 (Kernel: test3)
vdom 7 vdoma (Kernel: vdoma)
vdom 4 vdoma2 (Kernel: vdoma2)
vdom 8 vdomb (Kernel: vdomb)
vdom 5 vdomb2 (Kernel: vdomb2)
vdom 9 vdomc (Kernel: vdomc)
vdom 6 vdomc2 (Kernel: vdomc2)

Inside FortiOS: Voice over IP (VoIP) Protection

The FortiOS SIP Application Layer Gateway (ALG) allows SIP calls to pass through a FortiGate by opening SIP
and RTP pinholes and performing source and destination IP address and port translation for SIP and RTP
packets.

There are a large number of SIP-related Internet Engineering Task Force (IETF) documents (Request for
Comments) that define behavior of SIP and related applications. FortiOS completly support RFC 3261 for SIP,
RFC 4566 for SDP and RFC 3262 for Provisional Response Acknowledgment (PRACK). FortiOS also supports
other SIP and SIP-related RFCs and performs Deep SIPmessage inspection for SIP statements defined in other
SIP RFCs.
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Advanced Voice over IP Protection
The FortiOS SIP Application Level Gateway (ALG) protects Voice over IP (SIP and SDP) services in Unified
Communication and NGN/IMS networks with the following advanced VoIP defense mechanisms.

Deep SIP message inspection (also called deep SIP header inspection)

Verifies SIP and SDP header syntax and protects SIP servers from potential SIP Fuzzing attacks. When a
violation is detected, FortiOS can impose counter measures and can also send automatic SIP response
messages to offload processing from the SIP server.

SIP message rate limiting

Allows rate limiting of SIPmessages per SIP request method. This prevents a SIP server from overload or from
DoS attacks using particular SIPmethods. For example, FortiOS can protect SIP servers from a flood of SIP
REGISTER or INVITEmessages, which can be caused by a DoS attack or a flash crowd.

SIP

INVITE

REGISTER

SUBSCRIBE

NOTIFY

REFER

UPDATE

OPTIONS

MESSAGE

ACK

PRACK

INFO

SIP

RTP and RTCP pinholing

RTP pinholing only forwards RTP/RTCP packets that conform to the particular session description of the
associated SIP dialog. If a SIP dialog is finished, FortiOS automatically closes the pinhole. RTP/RTCP pinholing
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is supported by FortiASIC acceleration and achieves high packet throughput at low jitter and delay.

Stateful SIP dialog tracking

FortiOS tracks SIPmessage sequences and prevents unwanted SIPmessages that are not related to a particular
SIP dialog. For instance, FortiOS can detect malicious SIP BYEmessages that do not conform with the
associated context of the SIP dialog.

Inspecting SIP over SSL/TLS (secure SIP)

Some SIP phones and SIP servers use SSL or TLS to encrypt SIP signalling traffic. To allow SIP over SSL/TLS
calls to pass through the FortiGate unit, the encrypted signalling traffic has to be unencrypted and inspected.
FortiOS intercepts and unencrypts and inspects the SIP packets. Allowed packets are then re-encrypted and
forwarded to their destination.

Inspecting SIP on multiple ports

FortiOS can detect and inspect SIP and SDPUDP and TCP sessions and SIP SSL sessions and ou can configure
the ports that the SIP ALG monitors for these sessions. In addition you can configure two different ports for SIP
UDP sessions and two different ports for SIP TCP sessions. The port configuration can be changed without
affecting other parts of the SIP configuration.

Carrier Grade protection
To protect VoIP infrastructure in carrier networks, FortiOS complies with typical carrier requirements for
availability and robustness.

High Availability

FortiOS supports a hot failover configuration with an active and a standby FortiGate device. FortiOS dynamically
updates the context on the standby unit with SIP and RTP related data. This enables the standby unit to takeover
stable voice calls in case of a planned or unplanned outage or failover of the active unit.

Geographical Redundancy of SIP servers

In FortiOS SIP server cluster configurations the active and standby units can be deployed in different
geographical locations. This configuration prevents a total outage of a SIP server infrastructure if one location
goes offline. FortiOS supports the detection of SIP server outages (loss of heartbeats) and a redirect of SIP
messages to the redundant SIP server location.

Logging and Reporting

FortiOS can log call related information internally or to an external SYSLOG or FortiAnalyzer unit. This includes
event logs that show particular SIP-related attacks or syntax violations with SIPmessages or logs that summarize
call statistics.

NAT/NAPT
FortiOS performs configurable network address translation for IP addresses in the SIP and SDP header. The SIP
ALG follows the configured NAT addresses in firewall virtual IPs and changes SIP header IP addresses
accordingly. RTP NAT is controlled by SIP/SDP and the firewall policy. This allows translating an unlimited
number of IP addresses without adding specific RTP policies.
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Header Manipulation

FortiOS SIP and SDP header manipulation supports SIP Network Address Translation (NAT) through FortiGate
units configured as NAT firewalls.

Port2

10.11.101.100

SIP Server Virtual IP: 172.20.120.50

Port1

172.20.120.141

FortiGate unit
In NAT/Route mode

1. Phone A sends a REGSTER

message to the SIP Server

SIP server
10.11.101.50

SIP Phone A
(PhoneA@172.20.120.20)

2. The FortiGate unit forwards the

REGSTER message to the

SIP Server

3. The SIP server sends a

200 OK response to Phone A

4. The SIP server sends an

INVITE request to Phone A

Client IP: 172.20.120.20

Server IP: 172.20.120.50

Port: UDP (x,5060)

REGISTER Contact: 172.20.120.20:y
Client IP: 172.20.120.20

Server IP: 10.11.101.50

Port: UDP (x,5060)

REGISTER Contact: 172.20.120.20:y

5. The FortiGate unit accepts the

session from the SIP server and

forwards the INVITE request to 

Phone A

PoPoPoPort2

101010.11.101.10

20.141

Hosted NAT traversal (HNT)

In many service provider networks, CPE firewall devices provide NAT without application awareness. This causes
issues for SIP/SDP and RTP traffic, since UAC IP address information references to the internal network behind
the far end firewall. VoIP calls cannot be connected successfully. FortiOSmitigates far end NAT issues (called
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Hosted NAT traversal) by probing the first RTP packet from the UAC and learning the far end NA(P)T binding.
FortiOS then updates the internal NAT binding for RTP accordingly.

FortiGate unit
with SIP ALG

Configured for Hosted
NAT Traversal

NAT device
(not SIP aware)

NAT device
(not SIP aware)

NAT device
(not SIP aware)

SIP Phone A
(PhoneA@192.168.10.1)

SIP Phone B
(PhoneB@192.168.20.1)

SIP Phone C
(PhoneC@192.168.30.1)

SIP

SIP + RTP SIP + RTP

SIP + RTP

10.11.101.10 10.11.101.20

10.21.101.1

SIP Server VIP

10.21.101.10

172.20.120.141

172.20.120.30

10.30.120.1

10.30.120.20

VoIP Session Controller

(SIP server)

(For example FortiGate Voice unit)

RTP Media session 

10.30.120.0.2020

tedd

101010101010.2.21.101.1

172.20.120
10.30.120.1

SIP PhPhPhPhPhPh C

SIP PhPhPhPhPhononone e e BSIP PhPh AA

Service
Provider
Network

IP Address conservation for NAT

In case of SIP and RTPNAT IP the original address information can get lost after translating to the provisioned IP
addresses. This IP address information is sometimes required for detailed billing records or debugging purposes.
FortiOS can maintain the original IP address information in a translated SIP header by adding it to the SIP/SDP
info line (i=) or by adding it to the original attribute (o=). Either option can be selected depending on the SIP billing
environment.

SIP ALG activation
The FortiOS SIP ALG is applied to SIP traffic accepted by a firewall policy that includes a VoIP profile. The VoIP
profile controls how the SIP ALG processes SIP sessions. FortiOS also includes a high-performance SIP session
helper that provides limited SIP functionality. In most cases the SIP ALG should be used because the SIP ALG
supports the complete range of FortiOS SIP features.
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Opt.

SIP

SIP

• Rate limiting and message blocking

• Stateful SIP tracking

• Message, header, and SDP syntax checking

• Network surveillance 

• NAT and IP topology Hiding

• Logging and debugging

• Native (D)DoS prevention

• Anomaly Detection and Prevention

• Security Policy

• IPsec VPN encryption, decryption

• Access control

• IP Routing and forwarding

• IPsec VPN encryption, decryption

• Intrusion Detection and Prevention

• Defined by Fortinet and Enterprise signatures

• SIP decoder identifies SIP sessions

Firewall

DoS 

Sensor

IPS 

Signatures

SIP ALG

Egress 

Router

SIP over IPv6
FortiOS, operating in NAT and in Transparent mode supports SIP over IPv6. The SIP ALG can process SIP
messages that use IPv6 addresses in the headers, bodies, and in the transport stack. The SIP ALG cannot modify
the IPv6 addresses in the SIP headers so FortiGate units cannot perform SIP or RTPNAT over IPv6 and also
cannot translate between IPv6 and IPv4 addresses.

Platform support and hardware acceleration
FortiOS supports VoIP protection with the SIP ALG on all FortiGate hardware platforms. Whenever a FortiGate
unit provides FortiASIC or SPM HW acceleration, the SIP ALG will use this option to fast-path RTP/RTCP traffic.

As well, since the SIP ALG is proxy-based, SIP control packets are not offloaded to NP4 or NP6 processors. But
actual voice or other media traffic can be offloaded to NP4 or NP6 processors after the SIP session is established.
Many FortiGate units also support low latencey hardware acceleration configurations that also enhance SIP voice
transmission.

FortiGate hardware acceleration provides a high throughput solution at very low jitter and delay. FortiOS provides
efficient and highly scalable protection for VoIP in emerging Enterprise and Carrier network. This complements
Fortinet’s NGFW and UTM offerings. VoIP protection can be easily added to any firewall policy just by adding a
VoIP profile.

VoIP protection is supported in FortiAnalyzer and FortiManager. Centralized logging and management are
essential for carrier and MSSP service provider and are influencing business case calculations.
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Common SIP VoIP configurations

This section describes some common SIP VoIP configurations and simplified SIP dialogs for these
configurations. This section also shows some examples of how adding a FortiGate affects SIP processing.

Peer to peer configuration
In the peer to peer configuration shown below, two SIP phones (in the example, FortiFones) communicate
directly with each other. The phones send SIP request and response messages back and forth between each
other to establish the SIP session.

SIP peer to peer configuration

  
3. RTP Media session opens when 

Phone B answers

1. Phone A dials Phone B 

by sending an INVITE request

2. Phone B is notified of incoming

call – phone rings

SIP Phone A SIP Phone B

(PhoneB@10.31.101.30)(PhoneA@10.31.101.20)

Peer to peer configurations are not very common because they require the SIP phones to keep track of the names
and addresses of all of the other SIP phones that they can communicate with. In most cases a SIP proxy or re-
direct server maintains addresses of a large number of SIP phones and a SIP phone starts a call by contacting the
SIP proxy server.

SIP proxy server configuration
A SIP proxy server act as intermediary between SIP phones and between SIP phones (for example, two
FortiFones) and other SIP servers. As shown below, SIP phones send request and response messages the SIP
proxy server. The proxy server forwards the messages to other clients or to other SIP proxy servers. Proxy servers
can hide SIP phones by proxying the signaling messages. To the other users on the VoIP network, the signaling
invitations look as if they come from the SIP proxy server.
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SIP in proxy mode

SIP Phone A SIP Phone B

SIP Proxy Server

  (PhoneB@10.31.101.30)(PhoneA@10.31.101.20)

1. SIP phones register with 

SIP proxy server

5. RTP Media session opens when 

Phone B answers

2. Phone A dials Phone B 

by sending an INVITE request

to the SIP proxy server

3. The proxy server looks up the SIP address

of Phone B and forwards the

INVITE request to Phone B

4. Phone B is

notified of incoming

call by proxy server

– phone rings

IP Ph BBB

A common SIP configuration would include multiple networks of SIP phones. Each of the networks would have its
own SIP server. Each SIP server would proxy the communication between phones on its own network and
between phones in different networks.

SIP redirect server configuration
A SIP redirect server accepts SIP requests, maps the addresses in the request into zero or more new addresses
and returns those addresses to the client. The redirect server does not initiate SIP requests or accept calls. As
shown below, SIP clients send INVITE requests to the redirect server, which then looks up the destination
address. The redirect server returns the destination address to the client. The client uses this address to send the
INVITE request directly to the destination SIP client.
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SIP in redirect model

SIP Phone A SIP Phone B
  (PhoneB@10.31.101.30)(PhoneA@10.31.101.20)

1. SIP phones register with

SIP redirect server

SIP Redirect Server

3. The redirect server looks up the

SIP address of Phone B and

sends Phone B’s address

back to Phone A

5. Phone B is

notified of incoming

call by Phone A

– phone rings

4. Phone A sends the INVITE

request to Phone B

6. RTP Media session opens when 

Phone B answers

2. Phone A dials Phone B 

by sending an INVITE

request to the redirect

server

SIP PPh AA SIP Phh BBB

no

SIP registrar configuration
A SIP registrar accepts SIP REGISTER requests from SIP phones for the purpose of updating a location database
with this contact information. This database can then become a SIP location service that can be used by SIP
proxy severs and redirect servers to locate SIP clients. As shown below, SIP clients send REGISTER requests to
the SIP registrar.
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SIP registrar and proxy servers

SIP Phone A SIP Phone B

SIP Proxy Server

SIP Registrar

(PhoneB@10.31.101.30)(PhoneA@10.31.101.20)

1. SIP phones register

with the SIP registrar

5. RTP Media session opens when 

Phone B answers

2. Phone A dials Phone B 

by sending an INVITE request

to the SIP proxy server
3. The SIP proxy server

looks up Phone A and

Phone B on the registrar

4. Phone B is

notified of incoming

call by proxy server

– phone rings

SIP with a FortiGate
Depending on your security requirements and network configuration FortiGates may be in many different places
in a SIP configuration. This section shows a few examples.

The diagram below shows a FortiGate installed between a SIP proxy server and SIP phones on the same
network. The FortiGate is operating in Transparent mode so both the proxy server and the phones are on the
same subnet. In this configuration, called SIP inspection without address translation, the FortiGate could be
protecting the SIP proxy server on the private network by implementing SIP security features for SIP sessions
between the SIP phones and the SIP proxy server.
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SIP network with FortiGate in Transparent mode

1. SIP phones register with 

SIP proxy server

2. Phone A dials Phone B 

by sending an INVITE request

to the SIP proxy server

3. The proxy server looks up the SIP 

address of Phone B and forwards

the INVITE request to Phone B

4. Phone B is

notified of incoming

call by proxy server

– phone rings

5. RTP media session

opens when Phone B 

answers

FortiGate unit
in Transparent mode

SIP proxy server
10.31.101.50

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@10.31.101.30)

FoFortrtrtrtiGiGiGiGatate unit

The phones and server use the same SIP dialogs as they would if the FortiGate was not present. However, the
FortiGate can be configured to control which devices on the network can connect to the SIP proxy server and can
also protect the SIP proxy server from SIP vulnerabilities.

The following diagram shows a FortiGate operating in NAT mode and installed between a private network and
the Internet. Some SIP phones and the SIP proxy server are connected to the private network and some SIP
phones are connected to the Internet. The SIP phones on the Internet can connect to the SIP proxy server
through the FortiGate and communication between SIP phones on the private network and SIP phones on the
Internet must pass through the FortiGate.
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SIP network with FortiGate in NAT mode

5. RTP Media session opens between

Phone A and Phone B when Phone B answers

Port1

172.20.120.141

SIP proxy server

virtual IP: 172.20.120.50

Port2

10.11.101.100

FortiGate-620B
cluster

in NAT/Route mode

1. SIP phone B registers with 

SIP proxy server

using the SIP proxy server virtual IP

2. Phone A dials Phone B 

by sending an INVITE request

to the SIP proxy server
3. The proxy server looks up the SIP 

address of Phone B and forwards

the INVITE request to Phone B

4. Phone B is

notified of an incoming

call by proxy server

– phone rings

SIP proxy server
10.31.101.50

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@172.20.120.30)

1. SIP phone A registers with 

SIP proxy server

17172.20.1

Po

17172.20.1

0

SISIP P P P PhPhPhPhPhPhPhPhonone B

SIP PhPhPhPhPhPhPhononone e e A

The phones and server use the same SIP dialog as they would if the FortiGate was not present. However, the
FortiGate can be configured to control which devices on the network can connect to the SIP proxy server and can
also protect the SIP proxy server from SIP vulnerabilities. In addition, the FortiGate has a firewall virtual IP that
forwards packets sent to the SIP proxy server Internet IP address (172.20.120.50) to the SIP proxy server internal
network IP address (10.31.101.30).

Since the FortiGate is operating in NAT mode it must translate packet source and destination IP addresses (and
optionally ports) as the sessions pass through the FortiGate. Also, the FortiGate must translate the addresses
contained in the SIP headers and SDP body of the SIPmessages. As well the FortiGate must open SIP and RTP
pinholes through the FortiGate. SIP pinholes allow SIP signaling sessions to pass through the FortiGate between
phones and between phones and SIP servers. RTP pinholes allow direct RTP communication between the SIP
phones once the SIP dialog has established the SIP call. Pinholes are opened automatically by the FortiGate.
Administrators do not add security policies for pinholes or for RTP sessions. All that is required is a security policy
that accepts SIP traffic.

Opening an RTP pinhole means opening a port on a FortiGate interface to allow RTP traffic to use that port to
pass through the FortiGate between the SIP phones on the Internet and SIP phones on the internal network. A
pinhole only accepts packets from one RTP session. Since a SIP call involves at least two media streams (one
from Phone A to Phone B and one from Phone B to Phone A) the FortiGate opens two RTP pinholes. Phone A
sends RTP packets through a pinhole in port2 and Phone B sends RTP packets through a pinhole in port1. The
FortiGate opens the pinholes when required by the SIP dialog and closes the pinholes when the SIP call is
completed. The FortiGate opens new pinholes for each SIP call.

Each RTP pinhole actually includes two port numbers. The RTP port number as defined in the SIPmessage and
an RTCP port number, which is the RTP port number plus 1. For example, if the SIP call used RTP port 3346 the
FortiGate would create a pinhole for ports 3346 and 3347.

3490 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 34 - VoIP Solutions: SIP SIPmessages and media protocols

SIP messages and media protocols

This section provides an overview of SIPmessages and how they communicate information about SIP sessions
and how SDP, RTP, and RTCP fits in with SIP communications.

SIP uses clear text messages to start, maintain, and end media sessions between SIP user agent clients (UACs)
and user agent servers (UASs). These messages form a SIP dialog. A typical SIP dialog begins with an INVITE
request message sent from a UAC to another UAC or to a UAS. The first INVITE request message attempts to
start a SIP call and includes information about the sending UAC and the receiving UAC as well as information
about the communication session.

If only two UACs are involved as shown below, the receiving UAC (Phone B) responds with a 180 Ringing and
then a 200 OK SIP response message that informs Phone A that Phone B received and accepted the request.
Phone A then sends an ACKmessage to notify Phone B that the SIP response was received. Phone A and Phone
B can then participate in the RTPmedia session set up by the SIPmessages.

When the phone call is complete, one of the UACs (in the example Phone B) hangs up sending a BYE request
message to Phone A. Phone A then sends a 200 OK response to Phone B acknowledging that the session has
ended.

Basic SIP dialog between two UACs

SIP Phone A
(Sending UAC

PhoneA@10.31.101.20)

SIP Phone B
(Receiving UAC

PhoneB@10.31.101.30)

1. INVITE (SIP request message to invite
SIP Phone B to start a SIP session)

4. ACK (SIP request message to confirm that
SIP Phone A received the response

from SIP Phone B)

5. RTP Media session between Phone A

and Phone B.

3. 200 OK (SIP response to the INVITE request 
to inform SIP Phone A

that the request is accepted)

2. 180 Ringing (SIP ringing response to the 
INVITE request)

6. BYE (SIP request message from SIP Phone B
to end the SIP session)

7. 200 OK (SIP response to the BYE request 
to end the SIP session)
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If a UAS in the form of a SIP proxy server is involved, similar messages are sent and received, but the proxy
server participates as an intermediary in the initial call setup. In the example below the SIP proxy server receives
the INVITE request from Phone A and forwards it to Phone B. The proxy server then sends a 100 Trying response
to Phone A. Phone B receives the INVITE request and responds with a 180 Ringing and then a 200 OK SIP
response message. These messages are received by the proxy server and forwarded to Phone A to notify Phone
A that Phone B received and accepted the request. Phone A then sends an ACKmessage to notify Phone B that
the SIP response was received. This response is received by the proxy server and forwarded to Phone B. Phone A
and Phone B can then participate in the media session independently of the proxy server.

When the phone call is complete Phone B hangs up sending a BYE request message to Phone A. Phone A then
sends a 200 OK response to Phone B acknowledging that the session has ended.

Basic SIP dialog between UACs with a SIP proxy server UAS

SIP Phone A
(Sending UAC

PhoneA@10.31.101.20)

SIP Phone B
(Receiving UAC

PhoneB@10.31.101.30)

SIP Proxy Server
(UAS

10.31.101.40)

1. INVITE (SIP request message to invite
SIP Phone B to start a SIP session)

2. INVITE (Forwarded by the UAS to Phone B)

8. ACK (SIP request message to confirm that
SIP Phone A received the response

from SIP Phone B)

7. 200 OK (Forwarded by the UAS
to Phone A)

6. 200 OK (SIP response to the INVITE request 
to inform SIP Phone A

that the request is accepted)

3. 100 Trying (UAS informs Phone A of trying
to contact Phone B)

4. 180 Ringing (SIP ringing response to the 
INVITE request)

5. 180 Ringing (Forwarded by the UAS
to Phone A)

10. BYE (SIP request message from SIP Phone B
to end the SIP session)

11. 200 OK (SIP response to the BYE request 
to end the SIP session)

9. RTP Media session between Phone A

and Phone B.

The SIPmessages include SIP headers that contain names and addresses of Phone A, Phone B and the proxy
server. This addressing information is used by the UACs and the proxy server during the call set up.

The SIPmessage body includes Session Description Protocol (SDP) statements that Phone A and Phone B use to
establish the media session. The SDP statements specify the type of media stream to use for the session (for
example, audio for SIP phone calls) and the protocol to use for the media stream (usually the Real Time Protocol
(RTP) media streaming protocol).
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Phone A includes the media session settings that it would like to use for the session in the INVITEmessage.
Phone B includes its response to these media settings in the 200 OK response. Phone A’s ACK response confirms
the settings that Phone A and Phone B then use for the media session.

Hardware accelerated RTP processing
FortiGates can offload RTP packet processing to network processor (NP) interfaces. This acceleration greatly
enhances the overall throughput and resulting in near speed RTP performance.

SIP request messages
SIP sessions always start with a SIP request message (also just called a SIP request). SIP request messages also
establish, maintain, and terminate SIP communication sessions. The following table lists some common SIP
request message types.

Common SIP request message types

Message Type Description

INVITE A client sends an INVITE request to invite another client to participate in a multimedia
session. The INVITE request body usually contains the description of the session.

ACK
The originator of an INVITEmessage sends an ACK request to confirm that the final
response to an INVITE request was received. If the INVITE request did not contain the
session description, it must be included in the ACK request.

PRACK In some cases, SIP uses provisional response messages to report on the progress of
the response to a SIP request message. The provisional response messages are sent
before the final SIP response message. Similar to an ACK request message, a PRACK
request message is sent to acknowledge that a provisional response message has
been received.

OPTIONS
The UA uses OPTIONSmessages to get information about the capabilities of a SIP
proxy. The SIP proxy server replies with a description of the SIPmethods, session
description protocols, and message encoding that are supported.

BYE A client sends a BYE request to end a session. A BYE request from either end of the
SIP session terminates the session.

CANCEL
A client sends a CANCEL request to cancel a previous INVITE request. A CANCEL
request has no effect if the SIP server processing the INVITE sends a final response to
the INVITE before receiving the CANCEL.

REGISTER A client sends a REGISTER request to a SIP registrar server with information about
the current location (IP address and so on) of the client. A SIP registrar server saves
the information it receives in REGISTER requests and makes this information
available to any SIP client or server attempting to locate the client.
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Message Type Description

Info For distributing mid-session signaling information along the signaling path for a SIP
call. I

Subscribe For requesting the current state and state updates of a remote node.

Notify Informs clients and servers of changes in state in the SIP network.

Refer Refers the recipient (identified by the Request-URI) to a third party according to the
contact information in the request.

Update Opens a pinhole for new or updated SDP information.

Response codes
(1xx, 202, 2xx,
3xx, 4xx, 5xx,
6xx)

Indicates the status of a transaction. For example: 200 OK, 202 Accepted, or 400 Bad
Request.

SIP response messages
SIP response messages (often just called SIP responses) provide status information in response to SIP request
messages. All SIP response messages include a response code and a reason phrase. There are five SIP
response message classes. They are described below.

There are also two types of SIP response messages, provisional and final. Final response messages convey the
result of the request processing, and are sent reliably. Provisional responses provide information on the progress
of the request processing, but may not be sent reliably. Provisional response messages start with 1xx and are
also called informational response messages.

Informational (or provisional)

Informational or provisional responses indicate that a request message was received and imply that the endpoint
is going to process the request. Information messages may not be sent reliably and may not require an
acknowledgement.

If the SIP implementation uses Provisional Response Acknowledgment (PRACK) (RFC 3262) then informational
or provisional messages are sent reliably and require a PRACKmessage to acknowledge that they have been
received.

Informational responses can contain the following reason codes and reason phrases:

100 Trying
180 Ringing
181 Call is being forwarded
182 Queued
183 Session progress

Success

Success responses indicate that a request message was received, understood, and accepted. Success responses
can contain the following reason codes and reason phrases:

200 OK
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202 Accepted

Redirection

Redirection responses indicate that more information is required for the endpoint to respond to a request
message. Redirection responses can contain the following reason codes and reason phrases:

300 Multiple choices
301 Moved permanently
302 Moved temporarily
305 Use proxy
380 Alternative service

Client error

Client error responses indicate that a request message was received by a server that contains syntax that the
server cannot understand (i.e. contains a syntax error) or cannot comply with. Client error responses include the
following reason codes and reason phrases:

400 Bad request 401 Unauthorized
402 Payment required 403 Forbidden
404 Not found 405 Method not allowed
406 Not acceptable            407 Proxy authentication required
408 Request time-out 409 Conflict
410 Gone 411 Length required
413 Request entity too large  414 Request-URL too large
415 Unsupported media type 420 Bad extension
480 Temporarily not available
481 Call leg/transaction does not exist
482 Loop detected
484 Address incomplete 483 Too many hops
486 Busy here 485 Ambiguous
488 Not acceptable here       487 Request canceled

Server error

Server error responses indicate that a server was unable to respond to a valid request message. Server error
responses include the following reason codes and reason phrases:

500 Server internal error
501 Not implemented
502 Bad gateway
502 Service unavailable
504 Gateway time-out
505 SIP version not supported

Global failure

Global failure responses indicate that there are no servers available that can respond to a request message.
Global failure responses include the following reason codes and reason phrases:

600 Busy everywhere
603 Decline
604 Does not exist anywhere
606 Not acceptable
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SIP message start line
The first line in a SIPmessage is called the start line. The start line in a request message is called the request-
line and the start line in a response message is called the status-line.

Request-line The first line of a SIP request message. The request-line includes the SIPmessage
type, the SIP protocol version, and a Request URI that indicates the user or service to
which this request is being addressed. The following example request-line specifies
the INVITEmessage type, the address of the sender of the message
(inviter@example.com), and the SIP version:

INVITE sip:inviter@example.com SIP/2.0

Status-line

The first line of a SIP response message. The status-line includes the SIP protocol
version, the response code, and the reason phrase. The example status-line includes
the SIP version, the response code (200) and the reason phrase (OK).

SIP/2.0 200 OK

SIP headers
Following the start line, SIPmessages contain SIP headers (also called SIP fields) that convey message
attributes and to modify message meaning. SIP headers are similar to HTTP header fields and always have the
following format:

<header_name>:<value>

SIPmessages can include the SIP headers listed in the following table:

SIP headers

SIP Header Description

Allow Lists the set of SIPmethods supported by the UA generating the message. All
methods, including ACK and CANCEL, understood by the UAMUST be included in the
list of methods in the Allow header field, when present. For example:

Allow: INVITE, ACK, OPTIONS, CANCEL, BYE

Call-ID

A globally unique identifier for the call, generated by the combination of a random
string and the sender’s host name or IP address. The combination of the To, From,
and Call-ID headers completely defines a peer-to-peer SIP relationship between the
sender and the receiver. This relationship is called a SIP dialog.

Call-ID: ddeg45e793@10.31.101.30
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SIP Header Description

Contact Included in SIP request messages, the Contact header contains the SIP URI of the
sender of the SIP request message. The receiver uses this URI to contact the sender.
For example:

Contact: Sender <sip:sender@10.31.100.20>t

Content-Length
The number of bytes in the message body (in bytes).

Content-Length: 126

Content-Type In addition to SIP headers, SIPmessages include a message body that contains
information about the content or communication being managed by the SIP session.
The Content-Type header specifies what the content of the SIPmessage is. For
example, if you are using SIP with SDP, the content of the SIPmessage is SDP code.

Content-Type: application/sdp

CSeq

The command sequence header contains a sequence integer that is increased for
each new SIP request message (but is not incremented in the response message).
This header also incudes the request name found in the request message request-
line. For example:

CSeq: 1 INVITE

Expires Gives the relative time after which the message (or content) expires. The actual time
and how the header is used depends on the SIPmethod. For example:

Expires: 5

From

Identifies the sender of the message. Responses to a message are sent to the
address of the sender. The following example includes the sender’s name (Sender)
and the sender’s SIP address (sender@10.31.101.20.):

From: Sender <sip:sender@10.31.101.20>

Max-forwards An integer in the range 0-255 that limits the number of proxies or gateways that can
forward the request message to the next downstream server. Also called the number
of hops, this value is decreased every time the message is forwarded. This can also be
useful when the client is attempting to trace a request chain that appears to be failing
or looping in mid-chain.

For example: Max-Forwards: 30

P-Asserted-
Identity

The P-Asserted-Identity header is used among trusted SIP entities to carry the identity
of the user sending a SIPmessage as it was verified by authentication. See RFC
3325. The header contains a SIP URI and an optional display-name, for example:

P-Asserted-Identity: "Example Person" <sip:10.31.101.50>
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SIP Header Description

RAck Sent in a PRACK request to support reliability of information or provisional response
messages. It contains two numbers and a method tag. For example:

RAck: 776656 1 INVITE

Record-Route

Inserted into request messages by a SIP proxy to force future requests to be routed
through the proxy. In the following example, the host at IP address 10.31.101.50 is a
SIP proxy. The lr parameter indicates the URI of a SIP proxy in Record-Route
headers.

Record-Route: <sip:10.31.101.50;lr>

Route Forces routing for a request message through one or more SIP proxies. The following
example includes two SIP proxies:

Route: <sip:172.20.120.10;lr>, <sip:10.31.101.50;lr>

RSeq

The RSeq header is used in information or provisional response messages to support
reliability of informational response messages. The header contains a single numeric
value. For example:

RSeq: 33456

To Identifies the receiver of the message. The address in this field is used to send the
message to the receiver. The following example includes the receiver’s name
(Receiver) and the receiver’s SIP address (receiver@10.31.101.30.):

To: Receiver <sip:receiver@10.31.101.30>

Via

Indicates the SIP version and protocol to be used for the SIP session and the address
to which to send the response to the message that contains the Via field. The
following example Via field indicates to use SIP version 2, UDP for media
communications, and to send the response to 10.31.101.20 using port 5060.

Via: SIP/2.0/UDP 10.31.101.20:5060

The SIP message body and SDP session profiles
The SIPmessage body describes the session to be initiated. For example, in a SIP phone call the body usually
includes audio codec types, sampling rates, server IP addresses and so on. For other types of SIP session the
body could contain text or binary data of any type which relates in some way to the session. The message body is
included in request and response messages.

Two possible SIPmessage body types:

l Session Description Protocol (SDP), most commonly used for SIP VoIP.
l Multipurpose Internet Mail Extensions (MIME)

SDP is most often used for VoIP and FortiGates support SDP content in SIPmessage bodies. SDP is a text-
based protocol used by SIP to control media sessions. SDP does not deliver media but provides a session profile
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that contains media details, transport addresses, parameter negotiation, and other session description metadata
for the participants in a media session. The participants use the information in the session profile to negotiate
how to communicate and to manage the media session. SDP is described by RFC 4566.

An SDP session profile always contains session information and may contain media information. Session
information appears at the start of the session profile and media information (using the m= attribute) follows.

SDP session profiles can include the attributes listed in the following table.

SDP session profile attributes

Attribute Description

a= Attributes to extend SDP in the form a=<attribute> or
a=<attribute>:<value>.

b= Contains information about the bandwidth required for the session or media in the
form b=<bandwidth_type>:<bandwidth>.

c= Connection data about the session including the network type (usually IN for Internet),
address type (IPv4 or IPv6), the connection source address, and other optional
information. For example:

c=IN IPv4 10.31.101.20

i=
A text string that contains information about the session. For example:

i=A audio presentation about SIP

k= Can be used to convey encryption keys over a secure and trusted channel. For
example:

k=clear:444gdduudjffdee
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Attribute Description

m=

Media information, consisting of one or more lines all starting with m= and containing
details about the media including the media type, the destination port or ports used by
the media, the protocol used by the media, and a media format description.

m=audio 49170 RTP 0 3
m-video 3345/2 udp 34
m-video 2910/2 RTP/AVP 3 56

Multiple media lines are needed if SIP is managing multiple types of media in one
session (for example, separate audio and video streams).

Multiple ports for a media stream are indicated using a slash. 3345/2 udp means
UDP ports 3345 and 3346. Usually RTP uses even-numbered ports for data with the
corresponding one-higher odd ports used for the RTCP session belonging to the RTP
session. So 2910/2 RTP/AVPmeans ports 2910 and 2912 are used for RTP and
2911 and 2913 are used for RTCP.

Media types include udp for an unspecified protocol that uses UDP, RTP or RTP/AVP
for standard RTP and RTP/SAVP for secure RTP.

o= The sender’s username, a session identifier, a session version number, the network
type (usually IN for Internet), the address type (for example, IPv4 or IPv6), and the
sending device’s IP address. The o= field becomes a universal identifier for this
version of this session description. For example:

o=PhoneA 5462346 332134 IN IP4 10.31.101.20

r=

Repeat times for a session. Used if a session will be repeated at one or more timed
intervals. Not normally used for VoIP calls. The times can be in different formats. For
example:

r=7d 1h 0 25h r=604800 3600 0 90000

s= Any text that describes the session or s= followed by a space. For example:

s=Call from inviter

t=

The start and stop time of the session. Sessions with no time restrictions (most VoIP
calls) have a start and stop time of 0.

t=0 0

v= SDP protocol version. The current SDP version is 0 so the v= field is always:

v=0

z=

Time zone adjustments. Used for scheduling repeated sessions that span the time
between changing from standard to daylight savings time.

z=2882844526 -1h 2898848070 0
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Example SIP messages
The following example SIP INVITE request message was sent by PhoneA to PhoneB. The first nine lines are the
SIP headers. The SDP profile starts with v=0 and the media part of the session profile is the last line, starting with
m=.

INVITE sip:PhoneB@172.20.120.30 SIP/2.0
Via: SIP/2.0/UDP 10.31.101.50:5060
From: PhoneA <sip:PhoneA@10.31.101.20>
To: PhoneB <sip:PhoneB@172.20.120.30>
Call-ID: 314159@10.31.101.20
CSeq: 1 INVITE
Contact: sip:PhoneA@10.31.101.20
Content-Type: application/sdp
Content-Length: 124
v=0
o=PhoneA 5462346 332134 IN IP4 10.31.101.20
s=Let's Talk
t=0 0
c=IN IP4 10.31.101.20
m=audio 49170 RTP 0 3

The following example shows a possible 200 OK SIP response message in response to the previous INVITE
request message. The response includes 200 OK which indicates success, followed by an echo of the original
SIP INVITE request followed by PhoneB’s SDP profile.

SIP/2.0 200 OK
Via: SIP/2.0/UDP 10.31.101.50:5060
From: PhoneA <sip:PhoneA@10.31.101.20>
To: PhoneB <sip:PhoneB@172.20.120.30>
Call-ID: 314159@10.31.101.20
CSeq: 1 INVITE
Contact: sip:PhoneB@10.31.101.30
Content-Type: application/sdp
Content-Length: 107
v=0
o=PhoneB 124333 67895 IN IP4 172.20.120.30
s=Hello!
t=0 0
c=IN IP4 172.20.120.30
m=audio 3456 RTP 0

SIP can support multiple media streams for a single SIP session. Each media steam will have its own c= and m=
lines in the body of the message. For example, the following message includes three media streams:

INVITE sip:PhoneB@172.20.120.30 SIP/2.0
Via: SIP/2.0/UDP 10.31.101.20:5060
From: PhoneA <sip:PhoneA@10.31.101.20>
To: PhoneB <sip:PhoneB@172.20.120.30>
Call-ID: 314159@10.31.101.20
CSeq: 1 INVITE
Contact: sip:PhoneA@10.31.101.20
Content-Type: application/sdp
Content-Length: 124
v=0
o=PhoneA 5462346 332134 IN IP4 10.31.101.20
s=Let's Talk
t=0 0
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c=IN IP4 10.31.101.20
m=audio 49170 RTP 0 3
c=IN IP4 10.31.101.20
m=audio 49172 RTP 0 3
c=IN IP4 10.31.101.20
m=audio 49174 RTP 0 3

The SIP session helper

The SIP session-helper is a high-performance solution that provides basic support for SIP calls passing through
the FortiGate by opening SIP and RTP pinholes and by performing NAT of the addresses in SIPmessages.

The SIP session helper:

l Understands SIP dialog messages.
l Keeps the states of the SIP transactions between SIP UAs and SIP servers.
l Translates SIP header and SDP information to account for NAT operations performed by the FortiGate.
l Opens up and closes dynamic SIP pinholes for SIP signalling traffic.
l Opens up and closes dynamic RTP and RTSP pinholes for RTP and RTSPmedia traffic.
l Provides basic SIP security as an access control device.
l Uses the intrusion protection (IPS) engine to perform basic SIP protocol checks.

SIP session helper configuration overview
By default FortiOS uses the SIP ALG for SIP traffic. If you want to use the SIP session helper you need to enter
the following command:

config system settings
set default-voip-alg-mode kernel-helper-based

end

The SIP session helper is set to listen for SIP traffic on TCP or UDP port 5060. SIP sessions using port 5060
accepted by a security policy that does not include a VoIP profile are processed by the SIP session helper.

You can enable and disable the SIP session helper, change the TCP or UDP port that the session helper listens
on for SIP traffic, and enable or disable SIP NAT tracing. If the FortiGate is operating with multiple VDOMs, each
VDOM can have a different SIP session helper configuration.

To have the SIP session helper process SIP sessions you need to add a security policy that accepts SIP sessions
on the configured SIP UDP or TCP ports. The security policies can have service set to ALL, or to the SIP pre-
defined firewall service, or a custom firewall service. The SIP pre-defined firewall service restricts the security
policy to only accepting sessions on UDP port 5060.

If NAT is enabled for security policies that accept SIP traffic, the SIP session helper translates addresses in SIP
headers and in the RDP profile and opens up pinholes as required for the SIP traffic. This includes security
policies that perform source NAT and security policies that contain virtual IPs that perform destination NAT and
port forwarding. No special SIP configuration is required for this address translation to occur, it is all handled
automatically by the SIP session helper according to the NAT configuration of the security policy that accepts the
SIP session.

To use the SIP session helper you must not add a VoIP profile to the security policy. If you add a VoIP profile, SIP
traffic bypasses the SIP session helper and is processed by the SIP ALG.
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In most cases you would want to use the SIP ALG since the SIP session helper
provides limited functionality. However, the SIP session helper is available and can be
useful for high-performance solutions where a high level of SIP security is not a
requirement.

Disabling and enabling the SIP session helper
You can use the following steps to disable the SIP session helper. You might want to disable the SIP session
helper if you don’t want the FortiGate to apply NAT or other SIP session help features to SIP traffic. With the SIP
session helper disabled, the FortiGate can still accept SIP sessions if they are allowed by a security policy, but the
FortiGate will not be able to open pinholes or NAT the addresses in the SIPmessages.

To disable the sip session helper

1. Enter the following command to find the sip session helper entry in the session-helper list:
show system session-helper

.

.

.
edit 13

set name sip
set port 5060
set protocol 17

next
.
.
.

This command output shows that the sip session helper listens in UDP port 5060 for SIP sessions.

2. Enter the following command to delete session-helper list entry number 13 to disable the sip session helper:
config system session-helper

delete 13
end

If you want to use the SIP session helper you can verify whether it is enabled or disabled using the show
system session-helper command.

You do not have to disable the SIP session helper to use the SIP ALG.

If the SIP session helper has been disabled by being removed from the session-helper list you can use the
following command to enable the SIP session helper by adding it back to the session helper list:

config system session-helper
edit 0

set name sip
set port 5060
set protocol 17

end
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Changing the port numbers that the SIP session helper listens on
You can use the following command to change the port number that the SIP session helper listens on for SIP
traffic to 5064. The SIP session helper listens on the same port number for UDP and TCP SIP sessions. In this
example, the SIP session helper is session helper 13:

config system session-helper
edit 13

set port 5064
end

The config system settings options sip-tcp-port, sip-udp-port, and
sip-ssl-port control the ports that the SIP ALG listens on for SIP sessions. See
Changing the port numbers that the SIP ALG listens on on page 3512.

Your FortiGate may use a different session helper number for SIP. Enter the following command to view the
session helpers:

show system session-helper
.
.
.
edit 13

set name sip
set port 5060
set protocol 17

end
.
.
.

Configuration example: SIP session helper in Transparent Mode
The figure below shows an example SIP network consisting of a FortiGate operating in Transparent mode
between two SIP phones. Since the FortiGate is operating in Transparent mode both phones are on the same
network and the FortiGate and the SIP session helper does not perform NAT. Even though the SIP session helper
is not performing NAT you can use this configuration to apply SIP session helper security features to the SIP
traffic.

The FortiGate requires two security policies that accept SIP packets. One to allow SIP Phone A to start a session
with SIP Phone B and one to allow SIP Phone B to start a session with SIP Phone A.

SIP network with FortiGate in Transparent mode

FortiGate unit
in Transparent mode

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@10.31.101.30)

Port1 Port2rt1 PoPo
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General configuration steps

The following general configuration steps are required for this SIP configuration that uses the SIP session helper.
This example includes security policies that specifically allow SIP sessions using UDP port 5060 from Phone A to
Phone B and from Phone B to Phone A. In most cases you would have more than two phones so would use more
general security policies. Also, you can set the firewall service to ALL to allow traffic other than SIP on UDP port
5060.

This example assumes that you have entered the following command to enable using the SIP session helper:

config system settings
set default-voip-alg-mode kernel-helper-based

end

1. Add firewall addresses for Phone A and Phone B.
2. Add a security policy that accepts SIP sessions initiated by Phone A.
3. Add a security policy that accepts SIP sessions initiated by Phone B.

Configuration steps - GUI

To add firewall addresses for the SIP phones

1. Go to Policy & Objects > Addresses.
2. Select Create New > Address to add the following addresses for Phone A and Phone B:

Category Address

Name Phone_A

Type IP/Netmask

Subnet / IP Range 10.31.101.20/255.255.255.255

Interface port1

Category Address

Name Phone_B

Type IP/Netmask

Subnet / IP Range 10.31.101.30/255.255.255.255

Interface port2

To add security policies to accept SIP sessions

1. Go to Policy & Objects > IPv4 Policy.
2. Select Create New to add a security policy.
3. Add a security policy to allow Phone A to send SIP request messages to Phone B:
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Incoming Interface port1

Outgoing Interface port2

Source Phone_A

Destination Address Phone_B

Schedule always

Service SIP

Action ACCEPT

4. Select OK.
5. Add a security policy to allow Phone B to send SIP request messages to Phone A:

Incoming Interface port2

Outgoing Interface port1

Source Address Phone_B

Destination Address Phone_A

Schedule always

Service SIP

Action ACCEPT

6. Select OK.

Configuration steps - CLI

To add firewall addresses for Phone A and Phone B and security policies to accept SIP sessions

1. Enter the following command to add firewall addresses for Phone A and Phone B.
config firewall address

edit Phone_A
set associated interface port1
set type ipmask
set subnet 10.31.101.20 255.255.255.255

next
edit Phone_B

set associated interface port2
set type ipmask
set subnet 10.31.101.30 255.255.255.255

end

2. Enter the following command to add security policies to allow Phone A to send SIP request messages to Phone B
and Phone B to send SIP request messages to Phone A.

config firewall policy
edit 0

set srcintf port1
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set dstintf port2
set srcaddr Phone_A
set dstaddr Phone_B
set action accept
set schedule always
set service SIP

next
edit 0

set srcintf port2
set dstintf port1
set srcaddr Phone_B
set dstaddr Phone_A
set action accept
set schedule always
set service SIP
set utm-status enable

end

SIP session helper diagnose commands
You can use the diagnose sys sip commands to display diagnostic information for the SIP session helper.

Use the following command to set the debug level for the SIP session helper. Different debug masks display
different levels of detail about SIP session helper activity.

diagnose sys sip debug-mask <debug_mask_int>

Use the following command to display the current list of SIP dialogs being processed by the SIP session help. You
can also use the clear option to delete all active SIP dialogs being processed by the SIP session helper.

diagnose sys sip dialog {clear | list}

Use the following command to display the current list of SIP NAT address mapping tables being used by the SIP
session helper.

diagnose sys sip mapping list

Use the following command to display the current SIP session helper activity including information about the SIP
dialogs, mappings, and other SIP session help counts. This command can be useful to get an overview of what
the SIP session helper is currently doing.

diagnose sys sip status

The SIP ALG

In most cases you should use the SIP Application Layer Gateway (ALG) for processing SIP sessions. The SIP
ALG provides the same basic SIP support as the SIP session helper. Additionally, the SIP ALG provides a wide
range of features that protect your network from SIP attacks, apply rate limiting to SIP sessions, check the syntax
of SIP and SDP content of SIPmessages, and provide detailed logging and reporting of SIP activity.

By default all SIP traffic is processed by the SIP ALG. If the policy that accepts the SIP traffic includes a VoIP
profile the SIP traffic is processed by that profile. If the policy does not include a SIP profile the SIP traffic is
processed by the SIP ALG using the default VoIP profile.

If a FortiGate or a VDOM has been configured to use the SIP session helper, you can change this behavior to the
default configuration of using the SIP ALG with the following command:

config system settings
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set default-voip-alg-mode proxy-based
end

From the GUI you can only configure VoIP security profiles and add them to security
policies if VoIP is turned on under System > Feature Visibility and if the Inspection
Mode is set to Proxy. However, you can always configure VoIP profiles and add them
to security profiles from the CLI. And if the default-voip-alg mode is set to
proxy-based the default SIP profile will still be used even if VoIP security profiles
are not visible from the GUI.

As shown in the figure below, the FortiGate SIP ALG intercepts SIP packets after they have been routed by the
routing module, accepted by a security policy and passed through DoS and IPS Sensors (if DoS and IPS are
enabled). The ALG raises SIP packets to the application layer, analyzes the SIP and SDP addressing information
in the SIPmessages, makes adjustments (for example, NAT) to this addressing if required, and then sends the
packets out the egress interface to their destination.

The SIP ALG provides:

l All the same features as the SIP session helper including NAT and SIP and RTP Pinholes.
l In addition for the ALG you can enable or disable RTP pinholing, SIP register pinholing and SIP contact pinholing.

In a signaling only environment where the RTP stream bypasses the FortiGate, you can disable RTP pinholing to
improve performance.

l SIP TCP and UDP support
l SIPMessage order checking
l Configurable Header line length maximums

3508 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 34 - VoIP Solutions: SIP The SIP ALG

The SIP ALG works at the application level after ingress packets are accepted by a security policy

Opt.

SIP

SIP

• Rate limiting and message blocking

• Stateful SIP tracking

• Message, header, and SDP syntax checking

• Network surveillance 

• NAT and IP topology Hiding

• Logging and debugging

• Native (D)DoS prevention

• Anomaly Detection and Prevention

• Security Policy

• IPsec VPN encryption, decryption

• Access control

• IP Routing and forwarding

• IPsec VPN encryption, decryption

• Intrusion Detection and Prevention

• Defined by Fortinet and Enterprise signatures

• SIP decoder identifies SIP sessions

Firewall

DoS 

Sensor

IPS 

Signatures

SIP ALG

Egress 

Router

l Message fragment assembly (TCP)
l If SIPmessages are fragmented across multiple packets, the FortiGate assembles the fragments, does inspection

and pass the message in its entirety to the SIP server as one packet. This offloads the server from doing all the TCP
processing of fragments.

l L4 Protocol Translation
l Message Flood Protection
l Protects a SIP server from intentional or unintentional DoS of flooding INVITE, REGISTER, and other SIPmethods

by allowing control of the rate that these massages pass through the FortiGate.
l SIPmessage type filtering
l The FortiGate can prevent specified SIPmessage types from passing through the FortiGate to a SIP server. For

example In a voice only SIP implementation, there may be no need to permit a SUBSCRIBEmessage to ever make
it’s way to the SIP call processor. Also, if a SIP server cannot process some SIPmessage types you can use SIP
message type filtering to block them. For example, a SIP server could have a bug that prevents it from processing
certain SIPmessages. In this case you can temporarily block these message types until problem with the SIP server
has been fixed.

l SIP statistics and logging
l SIP over IPv6
l SIP over SSL/TLS
l Deep SIPmessage syntax checking (also called deep SIP header inspection or SIP fuzzing protection). Prevents

attacks that use malformed SIPmessages. Can check many SIP headers and SDP statements. Configurable
bypass and modification options.
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l Hosted NAT traversal, Resolves IP address issue in SIP and SDP lines due to NAT-PT in far end firewall. Important
feature for VoIP access networks.

l SIP High Availability (HA), including active-passive clustering and session pickup (session failover) for SIP sessions.
l Geographical Redundancy. In an HA configuration, if the active SIP server fails (missing SIP heartbeat messages or

SIP traffic) SIP sessions can be redirected to a secondary SIP server in another location.
l SIP per request method message rate limitation with configurable threshold for SIPmessage rates per request

method. Protects SIP servers from SIP overload and DoS attacks.
l RTP Bypass, Supports configurations with and without RTP pinholing. May inspect and protect SIP signaling only.
l SIP NAT with IP address conservation. Performs SIP and RTP aware IP Network Address translation. Preserves the

lost IP address information in the SDP profile i= line for later processing/debugging in the SIP server. See NAT with
IP address conservation on page 3541.

l IP topology hiding
l The IP topology of a network can be hidden through NAT and NAPT manipulation of IP and SIP level addressing.

For example, see SIP NAT scenario: source address translation (source NAT) on page 3527.
l SIP inspection without address translation
l The SIP ALG inspects SIPmessages but addresses in the messages are not translated. This feature can be applied

to a FortiGate operating in Transparent mode or in NAT mode. In Transparent mode you add normal Transparent
mode security policies that enable the SIP ALG and include a VoIP profile that causes the SIP ALG to inspect SIP
traffic as required. For an example configuration, see Configuration example: SIP in Transparent Mode on page
3517.

l For a FortiGate operating in NAT mode, if SIP traffic can pass between different networks without requiring NAT
because is supported by the routing configuration, you can add security policies that accept SIP traffic without
enabling NAT. In the VoIP profile you can configure the SIP ALG to inspect SIP traffic as required.

Enabling VoIP support from the GUI

SIP ALG configuration overview
To apply the SIP ALG, you add a SIP VoIP profile to a security policy that accepts SIP sessions. All SIP sessions
accepted by the security policy will be processed by the SIP ALG using the settings in the VoIP profile. The VoIP
profile contains settings that are applied to SIP, Session Initiation Protocol for Instant Messaging and Presence
Leveraging Extensions (SIMPLE) and Skinny Call Control Protocol (SCCP) sessions. All SCCP sessions accepted
by the security policy are also processed by the ALG. You configure SIP and SCCP settings separately. SIP
settings also apply to SIMPLE sessions.

VoIP profiles
You can customize the default VoIP profile or add new VoIP profiles.

To add a new VoIP profile from the GUI go to Security Profiles > VoIP and select Create New (the + button).

For SIP, from the GUI you can configure the VoIP profile to limit the number of SIP REGISTER and INVITE
requests. Many additional options for configuring how the ALG processes SIP sessions are available from the
CLI.

For SCCP you can limit the call setup time. Additional SCCP options are available from the CLI.

Use the following command to add a VoIP profile named VoIP_Pro_1 from the CLI:

config voip profile
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edit VoIP_Pro_1
end

FortiGates include two pre-defined VoIP profiles. On the GUI these profiles look identical. However, the CLI-only
settings result in the following functionality.

default The most commonly used VoIP profile. This profile enables both SIP and SCCP and
places the minimum restrictions on what calls will be allowed to negotiate. This profile
allows normal SCCP, SIP and RTP sessions and enables the following security
settings:

• strict-register to open smaller more secure pinholes (see Enhancing SIP
pinhole security on page 3547).
•  block-long-lines to block SIPmessages with lines that exceed maximum line
lengths.
•  block-unknown to block unrecognized SIP request messages.
•  open-record-route-pinhole to open pinholes for Record-Route messages.
•  nat-trace (see NAT with IP address conservation on page 3541).
•  contact-fixup perform NAT on the IP addresses and port numbers in SIP
headers in SIP CONTACT messages even if they don’t match the session’s IP address
and port numbers.
•  ips-rtp to enable IPS in security policies that also accept SIP sessions to protect
the SIP traffic from SIP-based attacks.

strict

This profile is available for users who want to validate SIPmessages and to only allow
SIP sessions that are compliant with RFC 3261. In addition to the settings in the
default VoIP profile, the strict profile sets all SIP deep message inspection header
checking options (for example, malformed-request-line and many others) to
discard. So the strict profile blocks and drops SIPmessages that contain malformed
SIP or SDP lines that can be detected by the ALG. For more information about SIP
deep header inspection, see Deep SIPmessage inspection on page 3555.

Neither of the default profiles applies SIP rate limiting. To apply more ALG features to SIP sessions you can clone
(copy) the pre-defined VoIP profiles and make your own modifications to them. You can clone VoIP profiles from
the GUI or the CLI. For example, from the CLI, to clone the default profile and configure the limit for SIP NOTIFY
request messages to 1000 messages per second per security policy and block SIP INFO request messages.
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config voip profile
clone default to my_voip_pro
edit my_voip_pro

config sip
set notify-rate 1000
set block-info enable

end
end

Changing the port numbers that the SIP ALG listens on
Most SIP configurations use TCP or UDP port 5060 for SIP sessions and port 5061 for SIP SSL sessions. If your
SIP network uses different ports for SIP sessions you can use the following command to configure the SIP ALG to
listen on a different TCP, UDP, or SSL ports. For example, to change the TCP port to 5064, the UDP port to
5065, and the SSL port to 5066.

config system settings
set sip-tcp-port 5064
set sip-udp-port 5065
set sip-ssl-port 5066

end

You also configure the SIP ALG to listen in two different TCP ports and two different UDP ports for SIP sessions.
For example, if you receive SIP TCP traffic on port 5060 and 5064 and UDP traffic on ports 5061 and 5065 you
can enter the following command to receive the SIP traffic on all of these ports:

config system settings
set sip-tcp-port 5060 5064
set sip-udp-port 5061 5065

end

Disabling the SIP ALG in a VoIP profile
SIP is enabled by default in a VoIP profile. If you are just using the VoIP profile for SCCP you can use the
following command to disable SIP in the VoIP profile.

config voip profile
edit VoIP_Pro_2

config sip
set status disable

end

SIP ALG diagnose commands
You can use the diagnose sys sip-proxy command to display diagnostic information for the SIP ALG. A
number of options are available including:

Use the following command to list all active SIP calls being processed by the SIP ALG. You can also use the
clear option to delete all active SIP calls being processed by the SIP ALG, the idle option to list idle SIP calls,
and the invite option to list SIP invite transactions.

diagnose sys sip-proxy calls {clear | list | idle | invite}

Use the following commands to employ filters to display specific information about the SIP ALG and the session
that it is processing. You can build up a filter by including a number of options such as source address, VoIP
profile, policy, and so on.

diagnose sys sip-proxy filter <filter_options>
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diagnose sys sip-proxy log-filter <filter_options>

Use the following command to display the active SIP rate limiting meters and their current settings.

diagnose sys sip-proxy meters list

Use the following command to display status information about the SIP sessions being processed by the SIP
ALG. You can also clear all SIP ALG statistics.

diagnose sys sip-proxy stats {clear | list}

Conflicts between the SIP ALG and the session helper

If you suspect that the SIP session helper is being used instead of the ALG, you can use the diagnose sys
sip command to determine if the SIP session helper is processing SIP sessions. For example, the following
command displays the overall status of the SIP sessions being processed by the SIP session helper:

The diagnose sys sip command only displays current status information. To see
activity the SIP session helper has to actually be processing SIP sessions when you
enter the command. For example, if the SIP session helper had been used for
processing calls that ended 5 minutes ago, the command output would show no SIP
session helper activity.

diagnose sys sip status
dialogs: max=32768, used=0
mappings: used=0
dialog hash by ID: size=2048, used=0, depth=0
dialog hash by RTP: size=2048, used=0, depth=0
mapping hash: size=2048, used=0, depth=0
count0: 0
count1: 0
count2: 0
count3: 0
count4: 0

This command output shows that the session helper is not processing SIP sessions because all of the used and
count fields are 0. If any of these fields contains non-zero values then the SIP session helper may be processing
SIP sessions.

Also, you can check to see if some ALG-only features are not being applied to all SIP sessions. For example,
FortiView pages displays statistics for SIP and SCCP calls processed by the ALG but not for calls processed by
the session helper. So if you see fewer calls than expected the session helper may be processing some of them.

Finally, you can check the policy usage and session information dashboard widgets to see if SIP sessions are
being accepted by the wrong security policies.

Stateful SIP tracking, call termination, and session inactivity timeout

The SIP ALG tracks SIP dialogs over their lifespan between the first INVITEmessage and the Final 200 OK and
ACKmessages. For every SIP dialog, stateful SIP tracking reviews every SIPmessage and makes adjustment to
SIP tracking tables as required. These adjustments include source and destination IP addresses, address
translation, dialog expiration information, and media stream port changes. Such changes can also result in
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dynamically opening and closing pinholes. You can use the diagnose sys sip-proxy stats list and
the diagnose sys sip-proxy filter command to view the SIP call data being tracked by the SIP ALG.

The SIP ALG uses the SIP Expires header line to time out a SIP dialog if the dialog is idle and a Re-INVITE or
UPDATEmessage is not received. The SIP ALG gets the Session-Expires value, if present, from the 200 OK
response to the INVITEmessage. If the SIP ALG receives an INVITE before the session times out, all timeout
values are reset to the settings in the new INVITEmessage or to default values. As a precautionary measure, the
SIP ALG uses hard timeout values to set the maximum amount of time a call can exist. This ensures that the
FortiGate is protected if a call ends prematurely.

When a SIP dialog ends normally, the SIP ALG deletes the SIP call information and closes open pinholes. A SIP
call can also end abnormally due to an unexpected signaling or transport event that cuts off the call. When a call
ends abnormally the SIPmessages to end the call may not be sent or received. A call can end abnormally for the
following reasons:

l Phones or servers crash during a call and a BYEmessage is not received.
l To attack a SIP system, a malicious user never send a BYEmessage.
l Poor implementations of SIP fail to process Record-Route messages and never send a BYEmessage.
l Network failures prevent a BYEmessage from being received.

Any phone or server in a SIP call can cancel the call by sending a CANCEL message. When a CANCEL message
is received by the FortiGate, the SIP ALG closes open pinholes. Before terminating the call, the ALG waits for the
final 200 OKmessage.

The SIP ALG can be configured to terminate SIP calls if the SIP dialog message flow or the call RTP (media)
stream is interrupted and does not recover. You can use the following commands to configure terminating
inactive SIP sessions and to set timers or counters to control when the call is terminated by the SIP ALG.

Adding a media stream timeout for SIP calls
Use the following command in a VoIP profile to terminate SIP calls accepted by a security policy containing the
VoIP profile when the RTPmedia stream is idle for 100 seconds.

config voip profile
edit VoIP_Pro_Name

config sip
set call-keepalive 100

end
end

You can adjust this setting between 1 and 10,080 seconds. The default call keepalive setting of 0 disables
terminating a call if the media stream is interrupted. Set call keepalive higher if your network has latency
problems that could temporarily interrupt media streams. If you have configured call keepalive and the FortiGate
terminates calls unexpectedly you can increase the call keepalive time to resolve the problem.

Call keep alive should be used with caution because enabling this feature results in
extra FortiGate CPU overhead and can cause delay/jitter for the VoIP call. Also, the
FortiGate terminates the call without sending SIPmessages to end the call. And if the
SIP endpoints send SIPmessages to terminate the call they will be blocked by the
FortiGate if they are sent after the FortiGate terminates the call.
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Adding an idle dialog setting for SIP calls
Use the following command in a VoIP profile to terminate SIP calls when for a single security policy, when the
configured number of SIP calls (or dialogs) has stopped receiving SIPmessages or has not received legitimate
SIPmessages. Using this command you can configure how many dialogs that have been accepted by a security
policy that the VoIP profile is added to become idle before the SIP ALG deletes the oldest ones. The following
command sets the maximum number of idle dialogs to 200:

config voip profile
edit VoIP_Pro_Name

config sip
set max-idle-dialogs 200

end
end

Idle dialogs would usually be dialogs that have been interrupted because of errors or problems or as the result of
a SIP attack that opens a large number of SIP dialogs without closing them. This command provides a way to
remove these dialogs from the dialog table and recover memory and resources being used by these open and idle
dialogs.

You can adjust this setting between 1 and a very high number. The default maximum idle dialogs setting of 0
disables this feature. Set maximum dialogs higher if your network has latency problems that could temporarily
interrupt SIPmessaging. If you have configured max idle dialogs and the FortiGate terminates calls unexpectedly
you can increase the max idle dialogs number to resolve the problem.

Changing how long to wait for call setup to complete
In some cases and some configurations your SIP system may experience delays during call setup. If this
happens, some SIP ALG timers may expire before call setup is complete and drop the call. In some cases you
may also want to reduce the amount of time the SIP ALG allows for call setup to complete.

You can use the provisional-invite-expiry-time SIP VoIP profile option to control how long the SIP
ALG waits for provisional INVITEmessages before assuming that the call setup has been interrupted and the SIP
call should be dropped. The default value for this timer is 210 seconds. You can change it to between 10 and
3600 seconds.

Use the following command to change the expiry time to 100 seconds.

config voip profile
edit Profile_name

config sip
set provisional-invite-expiry-time 100

end
end

SIP and RTP/RTCP

FortiGates support the Real Time Protocol (RTP) application layer protocol for the VoIP call audio stream. RTP
uses dynamically assigned port numbers that can change during a call. SIP control messages that start a call and
that are sent during the call inform callers of the port number to use and of port number changes during the call.

During a call, each RTP session will usually have a corresponding Real Time Control Protocol (RTCP) session. By
default, the RTCP session port number is one higher than the RTP port number.
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The RTP port number is included in the m= part of the SDP profile. In the example above, the SIP INVITE
message includes RTP port number is 49170 so the RTCP port number would be 49171. In the SIP response
message the RTP port number is 3456 so the RTCP port number would be 3457.

How the SIP ALG creates RTP pinholes

The SIP ALG requires the following information to create a pinhole. The SIP ALG finds this information in SIP
messages and some is provided by the SIP ALG:

Protocol UDP (Extracted from SIPmessages by the SIP ALG.)

Source IP Any

Source port Any

Destination IP

The SIP ALG extracts the destination IP address from the c= line in the SDP profile.
The c= line can appear in either the session or media part of the SDP profile. The SIP
ALG uses the IP address in the c= line of the media part of the SDP profile first. If the
media part does not contain a c= line, the SIP ALG checks the c= line in the session
part of the SDP profile. If the session part of the profile doesn’t contain a c= line the
packet is dropped. Pinholes for RTP and RTCP sessions share the same destination
IP address.

Destination port The SIP ALG extracts the destination port number for RTP from the m= field and adds
1 to this number to get the RTCP port number.

Lifetime The length of time during which the pinhole will be open. When the lifetime ends, the
SIP ALG removes the pinhole.

The SIP ALG keeps RTP pinholes open as long as the SIP session is alive. When the associated SIP session is
terminated by the SIP ALG or the SIP phones or servers participating in the call, the RTP pinhole is closed.

The figure below shows a simplified call setup sequence that shows how the SIP ALG opens pinholes. Phone A
and Phone B are installed on either side of a FortiGate operating in Transparent mode. Phone A and Phone B are
on the same subnet. The FortiGate includes a security policy that accepts SIP sessions from port1 to port2 and
from port2 to port1. The FortiGate does not require an RTP security policy, just the SIP policy.

You can see from this diagram that the SDP profile in the INVITE request from Phone A indicates that Phone A is
expecting to receive a media stream sent to its IP address using port 4000 for RTP and port 4001 for RTCP. The
SIP ALG creates pinhole 1 to allow this media traffic to pass through the FortiGate. Pinhole 1 is opened on the
Port2 interface and will accept media traffic sent from Phone B to Phone A.

When Phone B receives the INVITE request from Phone A, Phone B will know to send media streams to Phone A
using destination IP address 10.31.101.20 and ports 4000 and 4001. The 200 OK response sent from Phone B
indicates that Phone B is expecting to receive a media stream sent to its IP address using ports 8000 and 8001.
The SIP ALG creates pinhole 2 to allow this media traffic to pass through the FortiGate. Pinhole 2 is opened on
the Port1 interface and will accept media traffic sent from Phone A to Phone B.
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SIP call setup with a FortiGate in Transparent mode

FortiGate unit
in Transparent mode

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@10.31.101.30)

1. Phone A sends an INVITE request

to Phone B

(SDP 10.31.101.20:4000)

3. The SIP ALG forwards the

INVITE request Phone B.

4. Phone B sends a 200 OK

response to Phone A

(SDP: 10.31.101.30:8000)

6. Phone B sends RTP and RTCP

media sessions to Phone A through

pinhole 1. Destination address:port

number 172.20.120.20:4000 and 4001

7. Phone A sends RTP and RTCP

media sessions to Phone B through

pinhole 2. Destination address:port

number 172.20.120.30:8000 and 8001

2. SIP ALG creates Pinhole 1.

Accepts traffic on Port2 with

destination address:port numbers

 10.31.101.20:4000 and 4001

5. SIP ALG creates Pinhole 2.

Accepts traffic on Port1 with

destination address:port numbers

 10.31.101.30:8000 and 8001

Pinhole 1

Pinhole 2

Port1 Port2

FoFortrtiGiGiGiGate unit

rt1 PoPo

Configuration example: SIP in Transparent Mode

The figure below shows an example SIP network consisting of a FortiGate operating in Transparent mode
between two SIP phones. Since the FortiGate is operating in Transparent mode both phones are on the same
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network and the FortiGate and the SIP ALG does not perform NAT. Even though the SIP ALG is not performing
NAT you can use this configuration to apply SIP security features to the SIP traffic.

The FortiGate requires two security policies that accept SIP packets. One to allow SIP Phone A to start a session
with SIP Phone B and one to allow SIP Phone B to start a session with SIP Phone A.

SIP network with FortiGate in Transparent mode

FortiGate unit
in Transparent mode

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@10.31.101.30)

Port1 Port2rt1 PoPo

General configuration steps
The following general configuration steps are required for this SIP configuration. This example uses the default
VoIP profile. The example also includes security policies that specifically allow SIP sessions using UDP port 5060
from Phone A to Phone B and from Phone B to Phone A. In most cases you would have more than two phones so
would use more general security policies. Also, you can set the security service to ALLto allow traffic other than
SIP on UDP port 5060.

1. Add firewall addresses for Phone A and Phone B.
2. Add a security policy that accepts SIP sessions initiated by Phone A and includes the default VoIP profile.
3. Add a security policy that accepts SIP sessions initiated by Phone B and includes the default VoIP profile.

Configuration steps - GUI

Before you begin this procedure you may have to go to System > Feature Visibility
and turn on VoIP.

To add firewall addresses for the SIP phones

1. Go to Policy & Objects > Addresses.
2. Add the following addresses for Phone A and Phone B:

Category Address

Name Phone_A

Type IP/Netmask

Subnet / IP Range 10.31.101.20/255.255.255.255

Interface port1
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Category Address

Name Phone_B

Type IP/Netmask

Subnet / IP Range 10.31.101.30/255.255.255.255

Interface port2

To add security policies to apply the SIP ALG to SIP sessions

1. Go to Policy & Objects > IPv4 Policy.
2. Add a security policy to allow Phone A to send SIP request messages to Phone B:

Incoming Interface port1

Outgoing Interface port2

Source Phone_A

Destination Address Phone_B

Schedule always

Service SIP

Action ACCEPT

3. Turn on VoIP and select the default VoIP profile.
4. Select OK.
5. Add a security policy to allow Phone B to send SIP request messages to Phone A:

Incoming Interface port2

Outgoing Interface port1

Source Phone_B

Destination Address Phone_A

Schedule always

Service SIP

Action ACCEPT

6. Turn on VoIP and select the default VoIP profile.
7. Select OK.
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Configuration steps - CLI

To add firewall addresses for Phone A and Phone B and security policies to apply the SIP ALG to SIP
sessions

1. Enter the following command to add firewall addresses for Phone A and Phone B.
config firewall address

edit Phone_A
set associated-interface port1
set type ipmask
set subnet 10.31.101.20 255.255.255.255

next
edit Phone_B

set associated-interface port2
set type ipmask
set subnet 10.31.101.30 255.255.255.255

end

2. Enter the following command to add security policies to allow Phone A to send SIP request messages to Phone B
and Phone B to send SIP request messages to Phone A.

config firewall policy
edit 0

set srcintf port1
set dstintf port2
set srcaddr Phone_A
set dstaddr Phone_B
set action accept
set schedule always
set service SIP
set utm-status enable
set voip-profile default

next
edit 0

set srcintf port2
set dstintf port1
set srcaddr Phone_B
set dstaddr Phone_A
set action accept
set schedule always
set service SIP
set utm-status enable
set voip-profile default

end

RTP enable/disable (RTP bypass)

You can configure the SIP ALG to stop from opening RTP pinholes. Called RTP bypass, this configuration can be
used when you want to apply SIP ALG features to SIP signalling messages but do not want the RTPmedia
streams to pass through the FortiGate. The FortiGate only acts as a signalling firewall and RTPmedia session
bypass the FortiGate and no pinholes need to be created.
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Enter the following command to enable RTP bypass in a VoIP profile by disabling opening RTP pinholes:

config voip profile
edit VoIP_Pro_1

config sip
set rtp disable

end
end

Opening and closing SIP register, contact, via and record-route pinholes

You can use the open-register-pinhole, open-contact-pinhole, open-via-port, and open-
record-route-pinhole VoIP profile CLI options to control whether the FortiGate opens various pinholes.

If open-register-pinhole is enabled (the default setting) the FortiGate opens pinholes for SIP Register
request messages. You can disable open-register-pinhole so that the FortiGate does not open pinholes
for SIP Register request messages.

If open-contact-pinhole is enabled (the default setting) the FortiGate opens pinholes for non-Register SIP
request messages. You can disable open-contact-pinhole so that the FortiGate does not open pinholes
for non-register requests. Non-register pinholes are usually opened for SIP INVITE requests.

If open-via-pinhole is disabled (the default setting) the FortiGate does not open pinholes for Via messages.
You can enable open-via-pinhole so that the FortiGate opens pinholes for Via messages.

If open-record-route-pinhole is enabled (the default setting) the FortiGate opens pinholes for Record-
Route messages. You can disable open-record-route-pinhole so that the FortiGate does not open
pinholes for Record-Route messages.

Usually you would want to open these pinholes. Keeping them closed may prevent SIP from functioning properly
through the FortiGate. They can be disabled, however, for interconnect scenarios (where all SIP traffic is between
proxies and traveling over a single session). In some cases these settings can also be disabled in access
scenarios if it is known that all users will be registering regularly so that their contact information can be learned
from the register request.

You might want to prevent pinholes from being opened to avoid creating a pinhole for every register or non-
register request. Each pinhole uses additional system memory, which can affect system performance if there are
hundreds or thousands of users, and requires refreshing which can take a relatively long amount of time if there
are thousands of active calls.

To configure a VoIP profile to prevent opening register and non-register pinholes:

config voip profile
edit VoIP_Pro_1

config sip
set open-register-pinhole disable
set open-contact-pinhole disable

end
end

In some cases you may not want to open pinholes for the port numbers specified in SIP Contact headers. For
example, in an interconnect scenario when a FortiGate is installed between two SIP servers and the only SIP
traffic through the FortiGate is between these SIP servers pinholes may not need to be opened for the port
numbers specified in the Contact header lines.
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If you disable open-register-pinhole then pinholes are not opened for ports in Contact header lines in SIP
Register messages. If you disable open-contact-pinhole then pinholes are not opened for ports in Contact
header lines in all SIPmessages except SIP Register messages.

Accepting SIP register responses

You can enable the VoIP profile open-via-pinhole options to accept a SIP Register response message from
a SIP server even if the source port of the Register response message is different from the destination port.

Most SIP servers use 5060 as the source port in the SIP register response. Some SIP servers, however, may use
a different source port. If your SIP server uses a different source port, you can enable open-via-pinhole and
the SIP ALG will create a temporary pinhole when the Register request from a SIP client includes a different
source port. The FortiGate will accept a SIP Register response with any source port number from the SIP server.

Enter the following command to enable accepting any source port from a SIP server:

config voip profile
edit VoIP_Pro_1

config sip
set open-via-pinhole enable

end
end

How the SIP ALG performs NAT

In most Network Address Translation (NAT) configurations, multiple hosts in a private network share a single
public IP address to access the Internet. For sessions originating on the private network for the Internet, NAT
replaces the private IP address of the PC in the private subnet with the public IP address of the NAT device. The
NAT device converts the public IP address for responses from the Internet back into the private address before
sending the response over the private network to the originator of the session.

Using NAT with SIP is more complex because of the IP addresses and media stream port numbers used in SIP
message headers and bodies. When a caller on the private network sends a SIPmessage to a phone or SIP
server on the Internet, the SIP ALG must translate the private network addresses in the SIPmessage to IP
addresses and port numbers that are valid on the Internet. When the response message is sent back to the caller,
the SIP ALG must translate these addresses back to valid private network addresses.

In addition, the media streams generated by the SIP session are independent of the SIPmessage sessions and
use varying port numbers that can also change during the media session. The SIP ALG opens pinholes to accept
these media sessions, using the information in the SIPmessages to determine the pinholes to open. The ALG
may also perform port translation on the media sessions.

When an INVITEmessage is received by the SIP ALG, the FortiGate extracts addressing and port number
information from the message header and stores it in a SIP dialog table. Similar to an IP session table the data in
the dialog table is used to translate addresses in subsequent SIPmessages that are part of the same SIP call.

When the SIP ALG receives a response to the INVITEmessage arrives, (for example, an ACK or 200 OK), the SIP
ALG compares the addresses in the message fields against the entries in the SIP dialog table to identify the call
context of the message. The SIP ALG then translates addresses in the SIPmessage before forwarding them to
their destination.
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The addressing and port number information in SDP fields is used by the ALG to reserve ports for the media
session and create a NAT mapping between them and the ports in the SDP fields. Because SDP uses sequential
ports for the RTP and RTCP channels, the ALG provides consecutive even-odd ports.

SIP ALG source address translation
When a SIP call is started by a phone on a private network destined for a phone on the Internet, only source
address translation is required. The phone on the private network attempts to contact the actual IP address of the
phone on the Internet. However, the source address of the phone on the private network is not routable on the
Internet so the SIP ALG must translate all private IP addresses in the SIPmessage into public IP addresses.

To configure the FortiGate for source address translation you add security policy that accepts sessions from the
internal network destined for the Internet. You must enable NAT for the security policy and add a VoIP profile.

When a SIP request is received from the internal to the external network, the SIP ALG replaces the private
network IP addresses and port numbers in the SIPmessage with the IP address of the FortiGate interface
connected to the Internet. Depending on the content of the message, the ALG translates addresses in the Via:,
Contact:, Route:, and Record-Route: SIP header fields. The message is then forwarded to the destination (either
a VoIP phone or a SIP server on the Internet).

The VoIP phone or server in the Internet sends responses to these SIPmessages to the external interface of the
FortiGate. The addresses in the response messages are translated back into private network addresses and the
response is forwarded to the originator of the request.

For the RTP communication between the SIP phones, the SIP ALG opens pinholes to allow media through the
FortiGate on the dynamically assigned ports negotiated based on information in the SDP and the Via:, Contact:,
and Record-Route: header fields. The pinholes also allow incoming packets to reach the Contact:, Via:, and
Record-Route: IP addresses and ports. When processing return traffic, the SIP ALG inserts the original Contact:,
Via:, Route:, and Record-Route: SIP fields back into the packets.

SIP ALG destination address translation
Incoming calls are directed from a SIP phone on the Internet to the interface of the FortiGate connected to the
Internet. To receive these calls you must add a security policy to accept SIP sessions from the Internet. The
security policy requires a firewall virtual IP. SIP INVITEmessages from the Internet connect to the external IP
address of the virtual IP. The SIP ALG uses the destination address translation defined in the virtual IP to
translated the addresses in the SIPmessage to addresses on the private network.

When a 200 OK response message arrives from the private network, the SIP ALG translates the addresses in the
message to Internet addresses and opens pinholes for media sessions from the private network to the Internet.

When the ACKmessage is received for the 200 OK, it is also intercepted by the SIP ALG. If the ACKmessage
contains SDP information, the SIP ALG checks to determine if the IP addresses and port numbers are not
changed from the previous INVITE. If they are, the SIP ALG deletes pinholes and creates new ones as required.
The ALG also monitors the Via:, Contact:, and Record-Route: SIP fields and opens new pinholes as required.

SIP Call Re-invite messages
SIP Re-INVITEmessages can dynamically add and remove media sessions during a call. When new media
sessions are added to a call the SIP ALG opens new pinholes and update SIP dialog data. When media sessions
are ended, the SIP ALG closes pinholes that are no longer needed and removes SIP dialog data.
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How the SIP ALG translates IP addresses in SIP headers
The SIP ALG applies NAT to SIP sessions by translating the IP addresses contained in SIP headers. For
example, the following SIPmessage contains most of the SIP fields that contain addresses that need to be
translated:

INVITE PhoneB@172.20.120.30 SIP/2.0
Via: SIP/2.0/UDP 172.20.120.50:5434
From: PhoneA@10.31.101.20
To: PhoneB@172.20.120.30
Call-ID: a12abcde@172.20.120.50
Contact: PhoneA@10.31.101.20:5434
Route: <sip:example@172.20.120.50:5060>
Record-Route: <sip:example@172.20.120.50:5060>

How IP address translation is performed depends on whether source NAT or destination NAT is applied to the
session containing the message:

Source NAT translation of IP addresses in SIP messages

Source NAT translation occurs for SIPmessages sent from a phone or server on a private network to a phone or
server on the Internet. The source addresses in the SIP header fields of the message are typically set to IP
addresses on the private network. The SIP ALG translates these addresses to the address the FortiGate interface
connected to the Internet.

Source NAT translation of IP addresses in SIP request messages

SIP header NAT action

To: None

From: Replace private network address with IP address of FortiGate interface connected to
the Internet.

Call-ID: Replace private network address with IP address of FortiGate interface connected to
the Internet.

Via: Replace private network address with IP address of FortiGate interface connected to
the Internet.

Request-URI: None

Contact: Replace private network address with IP address of FortiGate interface connected to
the Internet.

Record-Route: Replace private network address with IP address of FortiGate interface connected to
the Internet.

Route: Replace private network address with IP address of FortiGate interface connected to
the Internet.
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Response messages from phones or servers on the Internet are sent to the FortiGate interface connected to the
Internet where the destination addresses are translated back to addresses on the private network before
forwarding the SIP response message to the private network.

Source NAT translation of IP addresses in SIP response messages

SIP header NAT action

To: None

From: Replace IP address of FortiGate interface connected to the Internet with private
network address.

Call-ID: Replace IP address of FortiGate interface connected to the Internet with private
network address.

Via: Replace IP address of FortiGate interface connected to the Internet with private
network address.

Request-URI: N/A

Contact: None

Record-Route: Replace IP address of FortiGate interface connected to the Internet with private
network address.

Route: Replace IP address of FortiGate interface connected to the Internet with private
network address.

Destination NAT translation of IP addresses in SIP messages

Destination NAT translation occurs for SIPmessages sent from a phone or server on the Internet to a firewall
virtual IP address. The destination addresses in the SIP header fields of the message are typically set to the
virtual IP address. The SIP ALG translates these addresses to the address of a SIP server or phone on the private
network on the other side of the FortiGate.

Destination NAT translation of IP addresses in SIP request messages

SIP header NAT action

To: Replace VIP address with address on the private network as defined in the firewall
virtual IP.

From: None

Call-ID: None

Via: None
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SIP header NAT action

Request-URI: Replace VIP address with address on the private network as defined in the firewall
virtual IP.

Contact: None

Record-Route: None

Route: None

SIP response messages sent in response to the destination NAT translated messages are sent from a server or a
phone on the private network back to the originator of the request messages on the Internet. These reply
messages are accepted by the same security policy that accepted the initial request messages, The firewall VIP
in the original security policy contains the information that the SIP ALG uses to translate the private network
source addresses in the SIP headers into the firewall virtual IP address.

Destination NAT translation of IP addresses in SIP response messages

SIP header NAT action

To: None

From: Replace private network address with firewall VIP address.

Call-ID: None

Via: None

Request-URI: N/A

Contact: Replace private network address with firewall VIP address.

Record-Route: Replace private network address with firewall VIP address.

Route: None

How the SIP ALG translates IP addresses in the SIP body
The SDP session profile attributes in the SIP body include IP addresses and port numbers that the SIP ALG uses
to create pinholes for the media stream.

The SIP ALG translates IP addresses and port numbers in the o=, c=, and m= SDP lines. For example, in the
following lines the ALG could translate the IP addresses in the o= and c= lines and the port number (49170) in the
m= line.

o=PhoneA 5462346 332134 IN IP4 10.31.101.20
c=IN IP4 10.31.101.20
m=audio 49170 RTP 0 3

3526 FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.



Chapter 34 - VoIP Solutions: SIP How the SIP ALG performs NAT

If the SDP session profile includes multiple RTPmedia streams, the SIP ALG opens pinholes and performs the
required address translation for each one.

The two most important SDP attributes for the SIP ALG are c= and m=. The c= attribute is the connection
information attribute. This field can appear at the session or media level. The syntax of the connection attribute
is:

c=IN {IPV4 | IPV6} <destination_ip_address>

Where

l IN is the network type. FortiGates support the IN or Internet network type.
l {IPV4 | IPV6} is the address type. FortiGates support IPv4 or IPv6 addresses in SDP statements. However,

FortiGates do not support all types of IPv6 address translation. See SIP over IPv6 on page 3554.
l <destination_IP_address> is the unicast numeric destination IP address or domain name of the connection

in either IPv4 or IPv6 format.

The syntax of the media attribute is:

m=audio <port_number> RTP <format_list>

Where

l audio is the media type. FortiGates support the audio media type.
l <port_number> is the destination port number used by the media stream.
l RTP is the application layer transport protocol used for the media stream. FortiGates support the Real Time

Protocol (RTP) transport protocol.
l <format_list> is the format list that provides information about the application layer protocol that the media

uses.

SIP NAT scenario: source address translation (source NAT)
The following figures show a source address translation scenario involving two SIP phones on different networks,
separated by a FortiGate. In the scenario, SIP Phone A sends an INVITE request to SIP Phone B and SIP Phone
B replies with a 200 OK response and then the two phones start media streams with each other.

To simplify the diagrams, some SIPmessages are not included (for example, the Ringing and ACK response
messages) and some SIP header lines and SDP profile lines have been removed from the SIPmessages.
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SIP source NAT scenario part 1: INVITE request sent from Phone A to Phone B

FortiGate unit
in NAT/Route mode

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@172.20.120.30)

1. Phone A sends an INVITE request

to Phone B

(SDP 10.31.101.20:4000).

3. The SIP ALG performs source NAT

on the INVITE request and forwards it

to Phone B.

2. SIP ALG creates Pinhole 1.

Accepts traffic on WAN1 with

destination address:port numbers

 172.20.120.122:49170 and 49171

Internal

10.31.101.100

WAN1

172.20.120.122

INVITE sip:PhoneB@172.20.120.30 SIP/2.0

Via: SIP/2.0/UDP 10.31.101.20:5060

From: PhoneA <sip:PhoneA@10.31.101.20>

To: PhoneB <sip:PhoneB@172.20.120.30>

Call-ID: 314159@10.31.101.20

CSeq: 1 INVITE

Contact: sip:PhoneA@10.31.101.20

v=0

o=PhoneA 5462346 332134 IN IP4 10.31.101.20

c=IN IP4 10.31.101.20

m=audio 49170 RTP 0 3

INVITE sip:PhoneB@172.20.120.30 SIP/2.0

Via: SIP/2.0/UDP 172.20.120.122:5060

From: PhoneA <sip:PhoneA@172.20.120.122>

To: PhoneB <sip:PhoneB@172.20.120.30>

Call-ID: 314159@172.20.120.122

CSeq: 1 INVITE

Contact: sip:PhoneA@172.20.120.122

v=0

o=PhoneA 5462346 332134 IN IP4 172.20.120.122

c=IN IP4 172.20.120.122

m=audio 49170 RTP 0 3

For the replies to SIP packets sent by Phone A to be routable on Phone Bs network, the FortiGate uses source
NAT to change their source address to the address of the WAN1 interface. The SIP ALG makes similar changes
the source addresses in the SIP headers and SDP profile. For example, the original INVITE request from Phone A
includes the address of Phone A (10.31.101.20) in the from header line. After the INVITE request passes through
the FortiGate, the address of Phone A in the From SIP header line is translated to 172.20.120.122, the address
of the FortiGate WAN1 interface. As a result, Phone B will reply to SIPmessages from Phone A using the WAN1
interface IP address.

The FortiGate also opens a pinhole so that it can accept media sessions sent to the WAN1 IP address using the
port number in the m= line of the INVITE request and forward them to Phone A after translating the destination
address to the IP address of Phone A.

Phone B sends the 200 OK response to the INVITEmessage to the WAN1 interface. The SDP profile includes the
port number that Phone B wants to use for its media stream. The FortiGate forwards 200 OK response to Phone
A after translating the addresses in the SIP and SDP lines back to the IP address of Phone A. The SIP ALG also
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opens a pinhole on the Internal interface that accepts media stream sessions from Phone A with destination
address set to the IP address of Phone B and using the port that Phone B added to the SDPm= line.

SIP source NAT scenario part 2: 200 OK returned and media streams established

6. The SIP ALG performs source NAT

on the 200 OK response and forwards

it to Phone A.

4. Phone B sends a 200 OK response to

Phone A (SDP: 172.20.120.30:3456).

7. Phone B sends RTP and RTCP

media sessions to Phone A through

pinhole 1. Destination address:port

number 172.20.120.122:49170

and 49171.

8. Phone A sends RTP and RTCP

media sessions to Phone B through

pinhole 2. Destination address:port

number 172.20.120.30:3456

and 3457.

5. SIP ALG creates Pinhole 2.

Accepts traffic on Internal with

destination address:port numbers

 172.20.120.30: 3456 and 3457..

Pinhole 1

Pinhole 2

SIP/2.0 200 OK

Via: SIP/2.0/UDP 172.20.120.122:5060

From: PhoneA <sip:PhoneA@172.20.120.122>

To: PhoneB <sip:PhoneB@172.20.120.30>

Call-ID: 314159@172.20.120.122

CSeq: 1 INVITE

Contact: sip:PhoneB@172.20.120.30

v=0

o=PhoneB 124333 67895 IN IP4 172.20.120.30

c=IN IP4 172.20.120.30

m=audio 3456 RTP 0

SIP/2.0 200 OK

Via: SIP/2.0/UDP 10.31.101.20:5060

From: PhoneA <sip:PhoneA@10.31.101.20>

To: PhoneB <sip:PhoneB@172.20.120.30>

Call-ID: 314159@10.31.101.20

CSeq: 1 INVITE

Contact: sip:PhoneB@172.20.120.30

v=0

o=PhoneB 124333 67895 IN IP4 172.20.120.30

c=IN IP4 172.20.120.30

m=audio 3456 RTP 0

FortiGate unit
in NAT/Route mode

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@172.20.120.30)

Internal

10.31.101.100

WAN1

172.20.120.122
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SIP NAT scenario: destination address translation (destination NAT)
The following figures show how the SIP ALG translates addresses in a SIP INVITEmessage sent from SIP Phone
B on the Internet to SIP Phone A on a private network using the SIP proxy server. Because the addresses on the
private network are not visible from the Internet, the security policy on the FortiGate that accepts SIP sessions
includes a virtual IP. Phone A sends SIP the INVITEmessage to the virtual IP address. The FortiGate accepts the
INVITEmessage packets and using the virtual IP, translates the destination address of the packet to the IP
address of the SIP proxy server and forwards the SIPmessage to it.

SIP destination NAT scenario part 1: INVITE request sent from Phone B to Phone A

Port1

172.20.120.141

SIP Virtual IP: 172.20.120.50

Port2

10.11.101.100

FortiGate-620B
Cluster

In NAT/Route mode

1. Phone B sends an INVITE request

for Phone A to the SIP Proxy Server

Virtual IP (SDP 172.20.120.30:4900)

SIP proxy server
10.31.101.50

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@172.20.120.30)

3. The SIP ALG performs destination

NAT on the INVITE request and

forwards it to the SIP proxy server.

4. The SIP proxy server forwards

the INVITE request to Phone A

(SDP: 172.20.120.30:4900)

2. SIP ALG creates Pinhole 1.

Accepts traffic on Port2 with

destination address:port numbers

 172.20.120.30:4900 and 4901

INVITE sip:PhoneA@172.20.120.50 SIP/2.0

Via: SIP/2.0/UDP 172.20.120.50:5060

From: PhoneB <sip:PhoneB@172.20.120.30>

To: PhoneA <sip:PhoneA@172.20.120.50>

Call-ID: 314134@172.20.120.30

CSeq: 1 INVITE

Contact: sip:PhoneB@172.20.120.30

v=0

o=PhoneB 2346 134 IN IP4 172.20.120.30

c=IN IP4 172.20.120.30

m=audio 4900 RTP 0 3

INVITE sip:PhoneA@10.31.101.50 SIP/2.0

Via: SIP/2.0/UDP 10.31.101.50:5060

From: PhoneB <sip:PhoneB@172.20.120.30>

To: PhoneA <sip:PhoneA@10.31.101.50>

Call-ID: 314134@172.20.120.30

CSeq: 1 INVITE

Contact: sip:PhoneB@172.20.120.30

v=0

o=PhoneB 2346 134 IN IP4 172.20.120.30

c=IN IP4 172.20.120.30

m=audio 4900 RTP 0 3

SIP P PhPhPhPhPhPhPhonononone e e A SIP P PhPhPhPhPhPhPhPhPhPhPhPhPhononononone e B

PoPo

171717172.2.20.1

1000

To simplify the diagrams, some SIPmessages are not included (for example, the Ringing and ACK response
messages) and some SIP header lines and SDP profile lines have been removed from the SIPmessages.

The SIP ALG also translates the destination addresses in the SIPmessage from the virtual IP address
(172.20.120.50) to the SIP proxy server address (10.31.101.50). For this configuration to work, the SIP proxy
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server must be able to change the destination addresses for Phone A in the SIPmessage from the address of the
SIP proxy server to the actual address of Phone A.

The SIP ALG also opens a pinhole on the Port2 interface that accepts media sessions from the private network to
SIP Phone B using ports 4900 and 4901.

Phone A sends a 200 OK response back to the SIP proxy server. The SIP proxy server forwards the response to
Phone B. The FortiGate accepts the 100 OK response. The SIP ALG translates the Phone A addresses back to
the SIP proxy server virtual IP address before forwarding the response back to Phone B. The SIP ALG also opens
a pinhole using the SIP proxy server virtual IP which is the address in the o= line of the SDP profile and the port
number in the m= line of the SDP code.

SIP destination NAT scenario part 2: 200 OK returned to Phone B and media streams established

SIP proxy server
10.31.101.50

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@172.20.120.30)

5. Phone A sends a 200 OK

response to the SIP proxy server

(SDP: 10.31.101.20:8888)
6. The SIP proxy server

forwards the response to

Phone B

(SDP: 10.31.101.20:8888)

7. The SIP ALG NATs the SDP

address to the Virtual IP address

before forwarding the response to

Phone B (SDP: 172.20.120.50:5500)

9. Phone A sends RTP and RTCP

media sessions to Phone B through

pinhole 1. Destination address:port

number 172.20.120.30:4900 and 4901

10. Phone B sends RTP and RTCP

media sessions to Phone A through

pinhole 2. Destination address:port

number 172.20.120.50:5500 and 5501.

11. The SIP ALG NATs the

destination address to

10.31.101.20.

8. Pinhole 2 created. Accepts traffic

on Port1 with destination

address:port numbers

 172.20.120.50:5500 and 5501

Pinhole 1

Pinhole 2

SIP/2.0 200 OK

Via: SIP/2.0/UDP 10.31.101.50:5060

From: PhoneB <sip:PhoneB@172.20.120.30>

To: PhoneA <sip:PhoneA@10.31.101.50>

Call-ID: 314134@172.20.120.30

CSeq: 1 INVITE

Contact: sip:PhoneB@172.20.120.30

v=0

o=PhoneB 2346 134 IN IP4 172.20.120.30

c=IN IP4 10.31.101.20

m=audio 5500 RTP 0

SIP/2.0 200 OK

Via: SIP/2.0/UDP 172.20.120.50:5060

From: PhoneB <sip:PhoneB@172.20.120.30>

To: PhoneA <sip:PhoneA@172.20.120.50>

Call-ID: 314134@172.20.120.30

CSeq: 1 INVITE

Contact: sip:PhoneB@172.20.120.30

v=0

o=PhoneB 2346 134 IN IP4 172.20.120.30

c=IN IP4 172.20.120.50

m=audio 5500 RTP 0

Port1

172.20.120.141

SIP Virtual IP: 172.20.120.50

Port2

10.11.101.100

FortiGate-620B
Cluster

In NAT/Route mode

PoPo

171717172.2.20.1

1000
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The media stream from Phone A is accepted by pinhole one and forwarded to Phone B. The source address of
this media stream is changed to the SIP proxy server virtual IP address. The media stream from Phone B is
accepted by pinhole 2 and forwarded to Phone B. The destination address of this media stream is changed to the
IP address of Phone A.

SIP NAT configuration example: source address translation (source NAT)
This configuration example shows how to configure the FortiGate to support the source address translation
scenario shown below. The FortiGate requires two security policies that accept SIP packets. One to allow SIP
Phone A to start a session with SIP Phone B and one to allow SIP Phone B to start a session with SIP Phone A.
Both of these policies must include source NAT. In this example the networks are not hidden from each other so
destination NAT is not required.

SIP source NAT configuration

FortiGate unit
in NAT/Route mode

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@172.20.120.30)

Internal

10.31.101.100

WAN1

172.20.120.122

FortiGiGatate unit

100 17172.

General configuration steps

The following general configuration steps are required for this SIP configuration. This example uses the default
VoIP profile. The example also includes security policies that specifically allow SIP sessions using UDP port 5060
from Phone A to Phone B and from Phone B to Phone A. In most cases you would have more than two phones so
would use more general security policies. Also, you can set the firewall service to ALL to allow traffic other than
SIP on UDP port 5060.

1. Add firewall addresses for Phone A and Phone B.
2. Add a security policy that accepts SIP sessions initiated by Phone A and includes the default VoIP profile.
3. Add a security policy that accepts SIP sessions initiated by Phone B and includes the default VoIP profile.

Configuration steps - GUI

To add firewall addresses for the SIP phones

1. Go to Policy & Objects > Addresses.
2. Add the following addresses for Phone A and Phone B:

Category Address

Name Phone_A

Type IP/Netmask
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Subnet / IP Range 10.31.101.20/255.255.255.255

Interface Internal

Category Address

Name Phone_B

Type IP/Netmask

Subnet / IP Range 172.20.120.30/255.255.255.255

Interface wan1

To add security policies to apply the SIP ALG to SIP sessions

1. Go to Policy & Objects > Policy > IPv4.
2. Add a security policy to allow Phone A to send SIP request messages to Phone B:

Incoming Interface internal

Outgoing Interface wan1

Source Phone_A

Destination Address Phone_B

Schedule always

Service SIP

Action ACCEPT

3. Turn on NAT and select Use Outgoing Interface Address.
4. Turn on VoIP and select the default VoIP profile.
5. Select OK.
6. Add a security policy to allow Phone B to send SIP request messages to Phone A:

Incoming Interface wan1

Outgoing Interface internal

Source Phone_B

Destination Address Phone_A

Schedule always

Service SIP

Action ACCEPT
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7. Turn on NAT and select Use Outgoing Interface Address.
8. Turn on VoIP and select the default VoIP profile.
9. Select OK.

Configuration steps - CLI

To add firewall addresses for Phone A and Phone B and security policies to apply the SIP ALG to SIP
sessions

1. Enter the following command to add firewall addresses for Phone A and Phone B.
config firewall address

edit Phone_A
set associated interface internal
set type ipmask
set subnet 10.31.101.20 255.255.255.255

next
edit Phone_B

set associated interface wan1
set type ipmask
set subnet 172.20.120.30 255.255.255.255

end

2. Enter the following command to add security policies to allow Phone A to send SIP request messages to Phone B
and Phone B to send SIP request messages to Phone A.

config firewall policy
edit 0

set srcintf internal
set dstintf wan1
set srcaddr Phone_A
set dstaddr Phone_B
set action accept
set schedule always
set service SIP
set nat enable
set utm-status enable
set voip-profile default

next
edit 0

set srcintf wan1
set dstintf internal
set srcaddr Phone_B
set dstaddr Phone_A
set action accept
set schedule always
set service SIP
set nat enable
set utm-status enable
set voip-profile default

end

SIP NAT configuration example: destination address translation (destination NAT)
This configuration example shows how to configure the FortiGate to support the destination address translation
scenario shown in the figure below. The FortiGate requires two SIP security policies:
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l A destination NAT security policy that allows SIPmessages to be sent from the Internet to the private network. This
policy must include destination NAT because the addresses on the private network are not routable on the Internet.

l A source NAT security policy that allows SIPmessages to be sent from the private network to the Internet.

SIP destination NAT scenario part two: 200 OK returned to Phone B and media streams established

SIP proxy server

Virtual IP: 172.20.120.50

SIP proxy server
10.31.101.50

SIP Phone A
(PhoneA@10.31.101.20)

SIP Phone B
(PhoneB@172.20.120.30)

Port1

172.20.120.141

Port2

10.11.101.100

FortiGate-620B
Cluster

In NAT/Route mode

SIP PhPhPhPhPhPhPhPhone e A SIP P PhPhPhPhPhPhPhPhonone B

PoPo

171717172.2.20.1

1000

General configuration steps

The following general configuration steps are required for this destination NAT SIP configuration. This example
uses the default VoIP profile.

1. Add the SIP proxy server firewall virtual IP.
2. Add a firewall address for the SIP proxy server on the private network.
3. Add a destination NAT security policy that accepts SIP sessions from the Internet destined for the SIP proxy server

virtual IP and translates the destination address to the IP address of the SIP proxy server on the private network.
4. Add a security policy that accepts SIP sessions initiated by the SIP proxy server and destined for the Internet.

Configuration steps - GUI

To add the SIP proxy server firewall virtual IP

1. Go to Policy & Objects > Virtual IPs.
2. Add the following SIP proxy server virtual IP.

VIP Type IPv4

Name SIP_Proxy_VIP

Interface port1

Type Static NAT

External IP Address/Range 172.20.120.50

Mapped IP Address/Range 10.31.101.50
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To add a firewall address for the SIP proxy server

1. Go to Policy & Objects > Addresses.
2. Add the following for the SIP proxy server:

Address Name SIP_Proxy_Server

Type Subnet

Subnet/IP Range 10.31.101.50/255.255.255.255

Interface port2

To add the security policies

1. Go to Policy & Objects > IPv4 Policy.
2. Add a destination NAT security policy that includes the SIP proxy server virtual IP that allows Phone B (and other

SIP phones on the Internet) to send SIP request messages to the SIP proxy server.

Incoming Interface port1

Outgoing Interface port2

Source all

Destination Address SIP_Proxy_VIP

Schedule always

Service SIP

Action ACCEPT

3. Turn on NAT and select Use Outgoing Interface Address.
4. Turn on VoIP and select the default VoIP profile.
5. Select OK.
6. Add a source NAT security policy to allow the SIP proxy server to send SIP request messages to Phone B and the

Internet:

Incoming Interface port2

Destination Address all

Source SIP_Proxy_Server

Schedule always

Service SIP

Action ACCEPT

7. Turn on NAT and select Use OutgingInterface Address.
8. Turn on VoIP and select the default VoIP profile.
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9. Select OK.

Configuration steps - CLI

To add the SIP proxy server firewall virtual IP and firewall address

1. Enter the following command to add the SIP proxy server firewall virtual IP.
config firewall vip

edit SIP_Proxy_VIP
set type static-nat
set extip 172.20.120.50
set mappedip 10.31.101.50
set extintf port1

end

2. Enter the following command to add the SIP proxy server firewall address.
config firewall address

edit SIP_Proxy_Server
set associated interface port2
set type ipmask
set subnet 10.31.101.50 255.255.255.255

end

To add security policies

1. Enter the following command to add a destination NAT security policy that includes the SIP proxy server virtual IP
that allows Phone B (and other SIP phones on the Internet) to send SIP request messages to the SIP proxy server.

config firewall policy
edit 0

set srcintf port1
set dstintf port2
set srcaddr all
set dstaddr SIP_Proxy_VIP
set action accept
set schedule always
set service SIP
set nat enable
set utm-status enable
set voip-profile default

end

2. Enter the following command to add a source NAT security policy to allow the SIP proxy server to send SIP request
messages to Phone B and the Internet:

config firewall policy
edit 0

set srcintf port2
set dstintf port1
set srcaddr SIP_Proxy_Server
set dstaddr all
set action accept
set schedule always
set service SIP
set nat enable
set utm-status enable
set voip-profile default
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end

SIP and RTP source NAT
In the source NAT scenario shown below, a SIP phone connects to the Internet through a FortiGate with and IP
address configured using PPPoE. The SIP ALG translates all private IPs in the SIP contact header into public IPs.

You need to configure an internal to external SIP security policy with NAT selected, and include a VoIP profile
with SIP enabled.

SIP source NAT

10.72.0.57

217.233.122.132

RTP Media

Server

217.10.79.9 217.10.69.11

SIP service provider has a SIP server

 and a separate RTP server

SIP Proxy

Server

FortiGate Unit

SIP and RTP destination NAT
In the following destination NAT scenario, a SIP phone can connect through the FortiGate to private IP address
using a firewall virtual IP (VIP). The SIP ALG translates the SIP contact header to the IP of the real SIP proxy
server located on the Internet.
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SIP destination NAT

10.72.0.57

SIP Proxy

Server

217.233.122.132

FortiGate Unit

RTP Media

Server

217.10.79.9

SIP service provider has a SIP server

 and a separate RTP server

217.10.69.11

10.72.0.60 217.23

FortiiGGaate Unit

.72.0.60

In the scenario, shown above, the SIP phone connects to a VIP (10.72.0.60). The SIP ALG translates the SIP
contact header to 217.10.79.9, opens RTP pinholes, and manages NAT.

The FortiGate also supports a variation of this scenario where the RTPmedia server’s IP address is hidden on a
private network or DMZ.
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SIP destination NAT-RTP media server hidden

219.29.81.21

SIP Proxy Server

217.233.90.60

FortiGate Unit

RTP Media

Server

10.0.0.60

192.168.200.99

In the scenario shown above, a SIP phone connects to the Internet. The VoIP service provider only publishes a
single public IP. The FortiGate is configured with a firewall VIP. The SIP phone connects to the FortiGate
(217.233.90.60) and using the VIP the FortiGate translates the SIP contact header to the SIP proxy server IP
address (10.0.0.60). The SIP proxy server changes the SIP/SDP connection information (which tells the SIP
phone which RTPmedia server IP it should contact) also to 217.233.90.60.

Source NAT with an IP pool
You can choose NAT with the Dynamic IP Pool option when configuring a security policy if the source IP of the
SIP packets is different from the interface IP. The FortiGate ALG interprets this configuration and translates the
SIP header accordingly.

This configuration also applies to destination NAT.

Different source and destination NAT for SIP and RTP
This is a more complex scenario that a SIP service provider may use. It can also be deployed in large-scale SIP
environments where RTP has to be processed by the FortiGate and the RTP server IP has to be translated
differently than the SIP serverIP.
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Different source and destination NAT for SIP and RTP

219.29.81.20

SIP Server

SIP: 217.233.90.60

RTP Servers

10.0.0.60

192.168.0.23

RTP Server

219.29.81.10192.168.0.21 - 

RTP-1: 217.233.90.65

RTP-2: 217.233.90.70

S

R

R

In this scenario, shown above, assume there is a SIP server and a separate media gateway. The SIP server is
configured so that the SIP phone (219.29.81.20) will connect to 217.233.90.60. The media gateway (RTP server:
219.29.81.10) will connect to 217.233.90.65.

What happens is as follows:

1. The SIP phone connects to the SIP VIP. The FortiGate ALG translates the SIP contact header to the SIP server:
219.29.81.20 > 217.233.90.60 (> 10.0.0.60).

2. The SIP server carries out RTP to 217.233.90.65.
3. The FortiGate ALG opens pinholes, assuming that it knows the ports to be opened.
4. RTP is sent to the RTP-VIP (217.233.90.65.) The FortiGate ALG translates the SIP contact header to

192.168.0.21.

NAT with IP address conservation
In a source or destination NAT security policy that accepts SIP sessions, you can configure the SIP ALG or the
SIP session helper to preserve the original source IP address of the SIPmessage in the i= line of the SDP profile.
NAT with IP address conservation (also called SIP NAT tracing) changes the contents of SIPmessages by adding
the source IP address of the originator of the message into the SDP i= line of the SIPmessage. The SDP i= line is
used for free-form text. However, if your SIP server can retrieve information from the SDP i= line, it can be useful
for keeping a record of the source IP address of the originator of a SIPmessage when operating in a NAT
environment. You can use this feature for billing purposes by extracting the IP address of the originator of the
message.

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

3541



How the SIP ALG performs NAT Chapter 34 - VoIP Solutions: SIP

Configuring SIP IP address conservation for the SIP ALG

You can use the following command to enable or disable SIP IP address conservation in a VoIP profile for the SIP
ALG. SIP IP address conservation is enabled by default in a VoIP profile.

config voip profile
edit VoIP_Pro_1

config sip
set nat-trace disable

end
end

If the SIPmessage does not include an i= line and if the original source IP address of the traffic (before NAT) was
10.31.101.20 then the FortiGate would add the following i= line.

i=(o=IN IP4 10.31.101.20)

You can also use the preserve-override option to configure the SIP ALG to either add the original o= line to
the end of the i= line or replace the i= line in the original message with a new i= line in the same form as above for
adding a new i= line.

By default, preserver-override is disabled and the SIP ALG adds the original o= line to the end of the
original i= line. Use the following command to configure the SIP ALG to replace the original i= line:

config voip profile
edit VoIP_Pro_1

config sip
set preserve-override enable

end
end

Configuring SIP IP address conservation for the SIP session helper

You can use the following command to enable or disable SIP IP address conservation for the SIP session helper.
IP address conservation is enabled by default for the SIP session helper.

config system settings
set sip-nat-trace disable

end

If the SIPmessage does not include an i= line and if the original source IP address of the traffic (before NAT) was
10.31.101.20 then the FortiGate would add the following i= line.

i=(o=IN IP4 10.31.101.20)

Controlling how the SIP ALG NATs SIP contact header line addresses
You can enable contact-fixup so that the SIP ALG performs normal SIP NAT translation to SIP contact
headers as SIPmessages pass through the FortiGate.

Disable contact-fixup if you do not want the SIP ALG to perform normal NAT translation of the SIP contact
header if a Record-Route header is also available. If contact-fixup is disabled, the FortiGate ALG does the
following with contact headers:

l For Contact in Requests, if a Record-Route header is present and the request comes from the external network, the
SIP Contact header is not translated.

l For Contact in Responses, if a Record-Route header is present and the response comes from the external network,
the SIP Contact header is not translated.
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If contact-fixup is disabled, the SIP ALG must be able to identify the external network. To identify the
external network, you must use the config system interface command to set the external keyword to
enable for the interface that is connected to the external network.

Enter the following command to perform normal NAT translation of the SIP contact header:

config voip profile
edit VoIP_Pro_1

config sip
set contact-fixup enable

end
end

Controlling NAT for addresses in SDP lines
You can use the no-sdp-fixup option to control whether the FortiGate performs NAT on addresses in SDP
lines in the SIPmessage body.

The no-sdp-fixup option is disabled by default and the FortiGate performs NAT on addresses in SDP lines.
Enable this option if you don’t want the FortiGate to perform NAT on the addresses in SDP lines.

config voip profile
edit VoIP_Pro_1

config sip
set no-sdp-fixup enable

end
end

Translating SIP session destination ports
Using port forwarding virtual IPs you can change the destination port of SIP sessions as they pass through the
FortiGate.

Translating SIP sessions to a different destination port

To configure translating SIP sessions to a different destination port you must add a static NAT virtual IP that
translates tie SIP destination port to another port destination. In the example the destination port is translated
from 5060 to 50601. This configuration can be used if SIP sessions uses different destination ports on different
networks.
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Example translating SIP sessions to a different destination port

Virtual Server

IP Address

172.20.120.20

TCP Port 5060

172.20.120.1

SIP Server

IP Phone

port1

port2

IP: 192.168.10.20

TCP Port 50601

ortt111111

To translate SIP sessions to a different destination port

1. Add the static NAT virtual IP.

This virtual IP forwards traffic received at the port1 interface for IP address 172.20.120.20 and destination port
5060 to the SIP server at IP address 192.168.10.20 with destination port 5061.

config firewall vip
edit "sip_port_trans_vip"

set type static-nat
set portforward enable
set protocol tcp
set extip 172.20.120.20
set extport 5060
set extintf "port1"
set mappedip 192.168.10.20
set mappedport 50601
set comment "Translate SIP destination port"

end

2. Add a security policy that includes the virtual IP and the default VoIP profile.
config firewall policy

edit 1
set srcintf "port1"
set dstintf "port2"
set srcaddr "all"
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set dstaddr "sip_port_trans_vip"
set action accept
set schedule "always"
set service "ALL"
set utm-status enable
set profile-protocol-options default
set comments "Translate SIP destination port"

end

Translating SIP sessions to multiple destination ports
You can use a load balance virtual IP to translate SIP session destination ports to a range of destination ports. In
this example the destination port is translated from 5060 to the range 50601 to 50603. This configuration can be
used if your SIP server is configured to receive SIP traffic on multiple ports.

Example translating SIP traffic to multiple destination ports

Virtual Server

IP Address

172.20.120.20

TCP Port 5060

172.20.120.1

SIP Server

IP Phone

port1

port2

IP: 192.168.10.20

50602

50603

TCP Ports: 50601

t11

p

To translated SIP sessions to multiple destination ports

1. Add the load balance virtual IP.

This virtual IP forwards traffic received at the port1 interface for IP address 172.20.120.20 and destination port
5060 to the SIP server at IP address 192.168.10.20 with destination port 5061.

config firewall vip
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edit "sip_port_ldbl_vip"
set type load-balance
set portforward enable
set protocol tcp
set extip 172.20.120.20
set extport 5060
set extintf "port1"
set mappedip 192.168.10.20
set mappedport 50601-50603
set comment "Translate SIP destination port range"

end

2. Add a security policy that includes the virtual IP and VoIP profile.
config firewall policy

edit 1
set srcintf "port1"
set dstintf "port2"
set srcaddr "all"
set dstaddr "sip_port_ldbl_vip"
set action accept
set schedule "always"
set service "ALL"
set utm-status enable
set voip-profile default
set comments "Translate SIP destination port"

end

Adding the original IP address and port to the SIP message header after NAT
In some cases your SIP configuration may require that the original IP address and port from the SIP contact
request is kept after NAT. For example, the original SIP contact request could include the following:

Contact: <sip:0150302438@172.20.120.110:5060>;

After the packet goes through the FortiGate and NAT is performed, the contact request could normally look like
the following (the IP address translated to a different IP address and the port to a different port):

Contact: <sip:0150302438@10.10.10.21:33608>;

You can enable register-contact-trace in a VoIP profile to have the SIP ALG add the original IP address
and port in the following format:

Contact: <sip:0150302438@<nated-ip>:<nated-port>;o=<original-ip>: <original-port>>;

So the contact line after NAT could look like the following:

Contact: <sip:0150302438@10.10.10.21:33608;o=172.20.120.110:5060>;

Enter the following command to enable keeping the original IP address and port:

config voip profile
edit Profile_name

config sip
set register-contract-trace enable

end
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Enhancing SIP pinhole security

You can use the strict-register option in a SIP VoIP profile to open smaller pinholes. This option is
enabled by default on the default VoIP profiles and in all new VoIP profiles that you create.

As shown below, when FortiGate is protecting a SIP server on a private network, the FortiGate does not have to
open a pinhole for the SIP server to send INVITE requests to a SIP Phone on the Internet after the SIP Phone has
registered with the server.

FortiGate protecting a SIP server on a private network

Port2

10.11.101.100

SIP Server Virtual IP: 172.20.120.50

Port1

172.20.120.141

FortiGate unit
In NAT/Route mode

1. Phone A sends a REGSTER

message to the SIP Server

SIP server
10.11.101.50

SIP Phone A
(PhoneA@172.20.120.20)

2. The FortiGate unit forwards the

REGSTER message to the

SIP Server

3. The SIP server sends a

200 OK response to Phone A

4. The SIP server sends an

INVITE request to Phone A

Client IP: 172.20.120.20

Server IP: 172.20.120.50

Port: UDP (x,5060)

REGISTER Contact: 172.20.120.20:y
Client IP: 172.20.120.20

Server IP: 10.11.101.50

Port: UDP (x,5060)

REGISTER Contact: 172.20.120.20:y

5. The FortiGate unit accepts the

session from the SIP server and

forwards the INVITE request to 

Phone A

PoPoPoPort2

101010.11.101.10

20.141

In the example, a client (SIP Phone A) sends a REGISTER request to the SIP server with the following
information:

Client IP: 10.31.101.20
Server IP: 10.21.101.50
Port: UDP (x,5060)
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REGISTER Contact: 10.31.101.20:y

Where x and y are ports chosen by Phone A.

As soon as the server sends the 200 OK reply it can forward INVITE requests from other SIP phones to SIP Phone
A. If the SIP proxy server uses the information in the REGISTERmessage received from SIP Phone A the INVITE
messages sent to Phone A will only get through the FortiGate if a policy has been added to allow the server to
send traffic from the private network to the Internet. Or the SIP ALG must open a pinhole to allow traffic from the
server to the Internet. In most cases the FortiGate is protecting the SIP server so there is no reason not to add a
security policy to allow the SIP server to send outbound traffic to the Internet.

In a typical SOHO scenario, shown below, SIP Phone A is being protected from the Internet by a FortiGate. In
most cases the FortiGate would not allow incoming traffic from the Internet to reach the private network. So the
only way that an INVITE request from the SIP server can reach SIP Phone A is if the SIP ALG creates an incoming
pinhole. All pinholes have three attributes:

(source address, destination address, destination port)

SOHO configuration, FortiGate protecting a network with SIP phones

Port2

10.11.101.100

Port1

172.20.120.141

FortiGate unit
In NAT/Route mode

1. Phone A sends a REGSTER

message to the SIP Proxy Server

SIP proxy server
172.20.120.50

SIP Phone A
(PhoneA@10.11.101.20)

2. The FortiGate unit forwards the

REGSTER message to the

SIP Proxy Server

4. The SIP Proxy server sends a

200 OK response to Phone A

5. The FortiGate unit accepts the

response through the open pinhole

and  forwards the response to

Phone A

Client IP: 10.11.101.20

Server IP: 172.20.120.50

Port: UDP (x,5060)

REGISTER Contact: 10.11.101.20:y

3. The FortiGate unit opens a pinhole

to accept sessions from the SIP server.

If strict-register is enabled the pinhole is

(172.20.120.50, 172.20.120.141,y)

If strict-register is disabled the pinhole

is (ANY, x,y)
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The more specific a pinhole is the more secure it is because it accept less traffic. In this situation, the pinhole
would be more secure if it only accepted traffic from the SIP server. This is what happens if strict-register
is enabled in the VoIP profile that accepts the REGISTER request from Phone A.

(SIP server IP address, client IP address, destination port)

If strict-register is disabled (the default configuration) the pinhole is set up with the following attributes

(ALL IP addresses, client IP address, destination port)

This pinhole allows connections through the FortiGate from ALL source address which is a much bigger and less
secure pinhole. In most similar network configurations you should enable strict-register to improve
pinhole security.

Enabling strict-register can cause problems when the SIP registrar and SIP proxy server are separate
entities with separate IP addresses.

Enter the following command to enable strict-register in a VoIP profile.

config voip profile
edit Profile_name

config sip
set strict-register enable

end

Hosted NAT traversal

With the increase in the use of VoIP and other media traffic over the Internet, service provider network
administrators must defend their networks from threats while allowing voice and multimedia traffic to flow
transparently between users and servers and among users. A common scenario could involve providing SIP VoIP
services for customers with SIP phones installed behind NAT devices that are not SIP aware. NAT devices that
are not SIP aware cannot translate IP addresses in SIP headers and SDP lines in SIP packets but can and do
perform source NAT on the source or addresses of the packets. In this scenario the user’s SIP phones would
communicate with a SIP proxy server to set up calls between SIP phones. Once the calls are set up RTP packets
would be communicated directly between the phones through each user’s NAT device.

The problem with this configuration is that the SIP headers and SDP lines in the SIP packets sent from the
phones and received by the SIP proxy server would contain the private network addresses of the VoIP phones that
would not be routable on the service provider network or on the Internet. One solution could be to for each
customer to install and configure SIP aware NAT devices. If this is not possible, another solution requires
implement hosted NAT traversal.

In a hosted NAT traversal (HNT) configuration, a FortiGate is installed between the NAT device and the SIP proxy
server and configured with a VoIP profile that enables SIP hosted NAT traversal. Security policies that include the
VoIP profile also support destination NAT using a firewall virtual IP. When the SIP phones connect to the SIP
server IP address the security policy accepts the SIP packets, the virtual IP translates the destination addresses
of the packets to the SIP server IP address, and the SIP ALG NAT traversal configuration translates the source IP
addresses on the SIP headers and SDP lines to the source address of the SIP packets (which would be the
external IP address of the NAT devices). The SIP server then sees the SIP phone IP address as the external IP
address of the NAT device. As a result SIP and RTPmedia sessions are established using the external IP
addresses of the NAT devices instead of the actual IP addresses of the SIP phones.
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FortiGate SIP Hosted NAT Traversal configuration

FortiGate unit
with SIP ALG

Configured for Hosted
NAT Traversal

NAT device
(not SIP aware)

NAT device
(not SIP aware)

NAT device
(not SIP aware)

SIP Phone A
(PhoneA@192.168.10.1)

SIP Phone B
(PhoneB@192.168.20.1)

SIP Phone C
(PhoneC@192.168.30.1)

SIP

SIP + RTP SIP + RTP

SIP + RTP

10.11.101.10 10.11.101.20

10.21.101.1

SIP Server VIP

10.21.101.10

172.20.120.141

172.20.120.30

10.30.120.1

10.30.120.20

VoIP Session Controller

(SIP server)

(For example FortiGate Voice unit)

RTP Media session 

10.30.120.0.2020

tedd

101010101010.2.21.101.1

172.20.120
10.30.120.1

SIP PhPhPhPhPhPh C

SIP PhPhPhPhPhononone e e BSIP PhPh AA

Service
Provider
Network

Configuration example: Hosted NAT traversal for calls between SIP Phone A and SIP
Phone B

The following address translation takes place to allow a SIP call from SIP Phone A to SIP Phone B in the above
diagram.

1. SIP Phone A sends a SIP Invite message to the SIP server. Packet source IP address: 192.168.10.1, destination
IP address: 10.21.101.10.

2. The SIP packets are received by the NAT device which translates the source address of the SIP packets from
192.168.10.1 to 10.11.101.20.

3. The SIP packets are received by the FortiGate which translates the packet destination IP address to 10.30 120.20.
The SIP ALG also translates the IP address of the SIP phone in the SIP header and SDP lines from 192.168.10.1
to 10.11.101.20.

4. The SIP server accepts the Invite message and forwards it to SIP Phone B at IP address10.11.101.20. The SIP
server has this address for SIP Phone B because SIP packets from SIP Phone B have also been translated using
the hosted NAT traversal configuration of the SIP ALG.

5. When the SIP call is established, the RTP session is between 10.11.101.10 and 10.11.101.20 and does not pass
through the FortiGate. The NAT devices translated the destination address of the RTP packets to the private IP
addresses of the SIP phones.
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General configuration steps

The following general configuration steps are required for this destination NAT SIP configuration. This example
uses the default VoIP profile.

1. Add a VoIP profile that enables hosted NAT translation.
2. Add a SIP proxy server firewall virtual IP.
3. Add a firewall address for the SIP proxy server on the private network.
4. Add a destination NAT security policy that accepts SIP sessions from the Internet destined for the SIP proxy server

virtual IP and translates the destination address to the IP address of the SIP proxy server on the private network.
5. Add a security policy that accepts SIP sessions initiated by the SIP proxy server and destined for the Internet.

Configuration steps - GUI

To add the SIP proxy server firewall virtual IP

1. Go to Policy & Objects > Virtual IPs.
2. Add the SIP proxy server virtual IP.

Name SIP_Proxy_VIP

External Interface port1

Type Static NAT

External IP Address/Range 172.20.120.50

Mapped IP Address/Range 10.31.101.50

To add a firewall address for the SIP proxy server

1. Go to Policy & Objects > Addresses.
2. Add the following for the SIP proxy server:

Category Address

Name SIP_Proxy_Server

Type Subnet

Subnet / IP Range 10.31.101.50/255.255.255.255

Interface port2

To add the security policies

1. Go to Policy & Objects > IPv4 Policy.
2. Add a destination NAT security policy that includes the SIP proxy server virtual IP that allows Phone B (and other

SIP phones on the Internet) to send SIP request messages to the SIP proxy server.
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Incoming Interface port1

Outgoing Interface port2

Source all

Destination Address SIP_Proxy_VIP

Schedule always

Service SIP

Action ACCEPT

3. TUrn on NAT and select Use Outgoing Interface Address.
4. Turn on VoIP and select the default VoIP profile.
5. Select OK.
6. Add a source NAT security policy to allow the SIP proxy server to send SIP request messages to Phone B and the

Internet:

Incoming Interface port2

Outgoing Interface port1

Source SIP_Proxy_Server

Destination Address all

Schedule always

Service SIP

Action ACCEPT

7. Tuen on NAT and select Use Outgoing Interface Address.
8. Turn on VoIP and select the default VoIP profile.
9. Select OK.

Configuration steps - CLI

To add a VoIP profile that enables hosted NAT translation

1. Enter the following command to add a VoIP profile named HNT that enables hosted NAT traversal. This command
shows how to clone the default VoIP profile and enable hosted NAT traversal.

config voip profile
clone default to HNT
edit HNT

config sip
set hosted-nat-traversal enable

end
end
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To add the SIP proxy server firewall virtual IP and firewall address

1. Enter the following command to add the SIP proxy server firewall virtual IP.
config firewall vip

edit SIP_Proxy_VIP
set type static-nat
set extip 10.21.101.10
set mappedip 10.30.120.20
set extintf port1

end

2. Enter the following command to add the SIP proxy server firewall address.
config firewall address

edit SIP_Proxy_Server
set associated interface port2
set type ipmask
set subnet 10.30.120.20 255.255.255.255

end

To add security policies

1. Enter the following command to add a destination NAT security policy that includes the SIP proxy server virtual IP
that allows Phone A to send SIP request messages to the SIP proxy server.

config firewall policy
edit 0

set srcintf port1
set dstintf port2
set srcaddr all
set dstaddr SIP_Proxy_VIP
set action accept
set schedule always
set service SIP
set nat enable
set utm-status enable
set profile-protocol-options default
set voip-profile HNT

end

2. Enter the following command to add a source NAT security policy to allow the SIP proxy server to send SIP request
messages to Phone B:

config firewall policy
edit 0

set srcintf port2
set dstintf port1
set srcaddr SIP_Proxy_Server
set dstaddr all
set action accept
set schedule always
set service SIP
set nat enable
set utm-status enable
set profile-protocol-options default
set voip-profile default

end
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Hosted NAT traversal for calls between SIP Phone A and SIP Phone C
The following address translation takes place to allow a SIP call from SIP Phone A to SIP Phone C in the previous
diagram.

1. SIP Phone A sends a SIP Invite message to the SIP server. Packet source IP address: 192.168.10.1 and
destination IP address: 10.21.101.10.

2. The SIP packets are received by the NAT device which translates the source address of the SIP packets from
192.168.10.1 to 10.11.101.20.

3. The SIP packets are received by the FortiGate which translates the packet destination IP address to 10.30 120.20.
The SIP ALG also translates the IP address of the SIP phone in the SIP header and SDP lines from 192.168.10.1
to 10.11.101.20.

4. The SIP server accepts the Invite message and forwards it to SIP Phone C at IP address 172.20.120.30. The SIP
server has this address for SIP Phone C because SIP packets from SIP Phone C have also been translated using
the hosted NAT traversal configuration of the SIP ALG.

5. When the SIP call is established, the RTP session is between 10.11.101.10 and 172.20.120.30. The packets pass
through the FortiGate which performs NAT as required.

Restricting the RTP source IP
Use the following command in a VoIP profile to restrict the RTP source IP to be the same as the SIP source IP
when hosted NAT traversal is enabled.

config voip profile
edit VoIP_HNT

config sip
set hosted-nat-traversal enable
set hnt-restrict-source-ip enable

end
end

SIP over IPv6

FortiGates operating in NAT and in Transparent mode support SIP over IPv6. The SIP ALG can process SIP
messages that use IPv6 addresses in the headers, bodies, and in the transport stack. The SIP ALG cannot modify
the IPv6 addresses in the SIP headers so FortiGates cannot perform SIP or RTPNAT over IPv6 and also cannot
translate between IPv6 and IPv4 addresses.

In the scenario shown inthe figure below, a SIP phone connects to the Internet through a FortiGate operating.
The phone and the SIP and RTP servers all have IPv6 addresses.

The FortiGate has IPv6 security policies that accept SIP sessions. The SIP ALG understands IPv6 addresses and
can forward IPv6 sessions to their destinations. Using SIP application control features the SIP ALG can also apply
rate limiting and other settings to SIP sessions.
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SIP support for IPv6

IPv6 address

SIP Server

IPv6 addresses

IPv6 firewall policy

RTP Server

IPv6 address IPv6 address

To enable SIP support for IPv6 add an IPv6 security policy that accepts SIP packets and includes a VoIP profile.

Deep SIP message inspection

Deep SIPmessage syntax inspection (also called Deep SIP header inspection or SIP fuzzing protection) provides
protection against malicious SIPmessages by applying SIP header and SDP profile syntax checking. SIP Fuzzing
attacks can be used by attackers to discover and exploit vulnerabilities of a SIP entity (for example a SIP proxy
server). Most often these attacks could crash or compromise the SIP entity.
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Deep SIP message inspection

FortiCarrier

Active

Blade

SIP message

Malformed SIP header 

�eld detected
Yes: Check next 

header �eld

Yes: Return

SIP client error

Response message

400 Bad Request

 or

413 Request entity too large

No

Discard message

Message compliant

• Checks the following SIP 

header fields:

• Checks the SIP request message 

Request-line

• Checks all SDP profile lines 

• Allow, Call-id, Contact, Content-

length, Content-type, CSeq,

Expires, From, Max-Forwards,

P-asserted-identity, Rack,

Record-Route, Route, Rseq, To, Via 

• Configurable header and body 

length checks

• Optional logging of message 

violations

SIP 

Parser

Configured:

“Pass” ?

Configured:

“Respond” 

?

If no

Deep SIPmessage inspection checks the syntax of each SIP header and SDP profile line to make sure they
conform to the syntax defined in the relevant RFC and IETF standard. You can also configure the SIP ALG to
inspect for:

l Unknown SIPmessage types (message types not defined in a SIP RFC) this option is enabled by default and can
be disabled. When enabled unknown message types are discarded. Configured using the block-unknown
option.

l Unknown line types (message line types that are not defined in any SIP or SDPRFC). Configured using the
unknown-header option.

l Messages that are longer than a configured maximum size. Configured using the max-body-length option.
l Messages that contain one or more lines that are longer that a set maximum line length (default 998 characters).

Configured using the max-line-length option.

Actions taken when a malformed message line is found
When a malformed message line or other error is found the SIP ALG can be configured to discard the message
containing the error, pass the message without any other actions, or responding to the message with a 400 Bad
Request or 413 Request entity too large client error SIP response message and then discard the message. (For
information about client error SIP response messages, see Client error on page 3495.)

If a message line is longer than the configured maximum, the SIP ALG sends the following message:

SIP/2.0 413 Request Entity Too Large, <optional_info>

If a message line is incorrect or in an unknown message line is found, the SIP ALG sends the following message:

SIP/2.0 400 Bad Request, <optional_info>

The <optional_info> provides more information about why the message was rejected. For example, if the
SIP ALG finds a malformed Via header line, the response message may be:
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SIP/2.0 400 Bad Request, malformed Via header

If the SIP ALG finds a malformed message line, and the action for this message line type is discard, the message
is discarded with no further checking or responses. If the action is pass, the SIP ALG continues parsing the SIP
message for more malformed message lines. If the action is respond, the SIP ALG sends the SIP response
message and discards the message containing the malformed line with no further checking or response. If only
malformed message line types with action set to pass are found, the SIP ALG extracts as much information as
possible from the message (for example for NAT and opening pinholes, and forwards the message to its
destination).

If a SIPmessage containing a malformed line is discarded the SIP ALG will not use the information in the
message for call processing. This could result in the call being terminated. If a malformed line in a SIPmessage
includes information required for the SIP call that the SIP ALG cannot interpret (for example, if an IP address
required for SIP NAT is corrupted) the SIP ALG may not be able to continue processing the call and it could be
terminated. Discarded messages are counted by SIP ALG static message counters.

Logging and statistics
To record a log message each time the SIP ALG finds a malformed header, enable logging SIP violations in a
VoIP profile. In all cases, when the SIP ALG finds an error the FortiGate records a malformed header log
message that contains information about the error. This happens even if the action is set to pass.

If, because of recording log messages for deep message inspection, the CPU performance is affected by a
certain amount, the FortiGate records a critical log message about this event and stops writing log messages for
deep SIPmessage inspection.

The following information is recorded in malformed header messages:

l The type of message line in which the error was found.
l The content of the message line in which the error was found (it will be truncated if it makes the log message too

long)
l The column or character number in which the error was found (to make it easier to determine what caused the error)

Deep SIP message inspection best practices
Because of the risks imposed by SIP header attacks or incorrect data being allowed and because selecting drop or
respond does not require more CPU overhead that pass you would want to set all tests to drop or respond.
However, in some cases malformed lines may be less of a threat or risk. For example, the SDP i= does not
usually contain information that is parsed by any SIP device so a malformed i= line may not pose a threat.

You can also used the pre-defined VoIP profiles to apply different levels of deep message inspection. The default
VoIP profile sets all deep message inspection options to pass and the strict VoIP profile sets all deep message
inspection options to discard. From the CLI you can use the clone command to copy these pre-defined VoIP
profiles and then customize them for your requirements.

Configuring deep SIP message inspection
You configure deep SIPmessage inspection in a VoIP profile. All deep SIPmessage inspection options are
available only from the CLI.

Enter the following command to configure deep SIPmessage inspection to discard messages with malformed
Request-lines (the first line in a SIP request message):

config voip profile
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edit VoIP_Pro_Name
config sip

set malformed-request-line respond
end

end

You cannot configure message inspection for the Status-line, which is the first line in a
SIP response message.

The following table lists the SIP header lines that the SIP ALG can inspect and the CLI command for configuring
the action for each line type. The table also lists the RFC that the header line is defined in.

SIP header lines that the SIP ALG can inspect for syntax errors

SIP Header line VoIP profile option RFC

Allow malformed-header-allow RFC 3261

Call-ID malformed-header-call-id RFC 3261

Contact malformed-header-contact RFC 3261

Content-Length malformed-header-content-length RFC 3261

Content-Type malformed-header-content-type RFC 3261

CSeq malformed-header-cseq RFC 3261

Expires malformed-header-expires RFC 3261

From malformed-header-from RFC 3261

Max-forwards malformed-header-max-forwards RFC 3261

P-Asserted-
Identity malformed-header-p-asserted-identity RFC 3325

RAck malformed-header-rack RFC 3262

Record-Route malformed-header-record-route RFC 3261

Route malformed-header-route RFC 3261

RSeq malformed-header-rseq RFC 3262

To malformed-header-to RFC 3261

Via malformed-header-via RFC 3261
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The table below lists the SDP profile lines that the SIP ALG inspects and the CLI command for configuring the
action for each line type. SDP profile lines are defined by RFC 4566 and RFC 2327.

SDP profile lines that the SIP ALG can inspect for syntax errors

Attribute VoIP profile option

a= malformed-header-sdb-a

b= malformed-header-sdp-b

c= malformed-header-sdp-c

i= malformed-header-sdp-i

k= malformed-header-sdp-k

m= malformed-header-sdp-m

o= malformed-header-sdp-o

r= malformed-header-sdp-r

s= malformed-header-sdp-s

t= malformed-header-sdp-t

v= malformed-header-sdp-v

z= malformed-header-sdp-z

Discarding SIP messages with some malformed header and body lines

Enter the following command to configure deep SIPmessage inspection to discard SIPmessages with a
malformed Via line, a malformed route line or a malformed m= line but to pass messages with a malformed i=
line or a malformed Max-Forwards line

config voip profile
edit VoIP_Pro_Name

config sip
set malformed-header-via discard
set malformed-header-route discard
set malformed-header-sdp-m discard
set malformed-header-sdp-i pass
set malformed-header-max-forwards pass

end
end

Discarding SIP messages with an unknown SIP message type

Enter the following command to discard SIPmessages with an unknown SIPmessage line type as defined in all
current SIP RFCs:

config voip profile
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edit VoIP_Pro_Name
config sip

set unknown-header discard
end

end

Discarding SIP messages that exceed a message size

Enter the following command to set the maximum size of a SIPmessage to 200 bytes. Messages longer than 200
bytes are discarded.

config voip profile
edit VoIP_Pro_Name

config sip
set max-body-length 200

end
end

The max-body-length option checks the value in the SIP Content-Length header line to determine body
length. The Content-Length can be larger than the actual size of a SIPmessage if the SIPmessage content is
split over more than one packet. SIPmessage sizes vary widely. The size of a SIPmessage can also change with
the addition of Via and Record-Route headers as the message is transmitted between users and SIP servers.

Discarding SIP messages with lines longer than 500 characters

Enter the following command to set the length of a SIPmessage line to 500 characters and to block messages
that include lines with 500 or more characters:

config voip profile
edit VoIP_Pro_Name

config sip
set max-line-length 500
set block-long-lines enable

end
end

Blocking SIP request messages

You may want to block different types of SIP requests:

l to prevent SIP attacks using these messages.
l If your SIP server cannot process some SIPmessages because of a temporary issue (for example a bug that

crashes or compromises the server when it receives a message of a certain type).
l Your SIP implementation does not use certain message types.

When you enable message blocking for a message type in a VoIP profile, whenever a security policy containing
the VoIP profile accepts a SIPmessage of this type, the SIP ALG silently discards the message and records a log
message about the action.

Use the following command to configure a VoIP profile to block SIP CANCEL and Update request messages:

config voip profile
edit VoIP_Pro_Name

config sip
set block-cancel enable
set block-update enable
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end
end

SIP uses a variety of text-based messages or requests to communicate information about SIP clients and servers
to the various components of the SIP network. Since SIP requests are simple text messages and since the
requests or their replies can contain information about network components on either side of the FortiGate, it
may be a security risk to allow these messages to pass through.

The following table lists all of the VoIP profile SIP request message blocking options. All of these options are
disabled by default.

Blocking SIP OPTIONSmessages may prevent a redundant configuration from
operating correctly. See Supporting geographic redundancy when blocking OPTIONS
messages on page 3569 for information about resolving this problem.

Options for blocking SIP request messages

SIP request mes-
sage SIP message blocking CLI Option

ACK block-ack

BYE block-bye

Cancel block-cancel

INFO block-info

INVITE block-invite

Message block-message

Notify block-notify

Options block-options

PRACK block-prack

Publish block-publish

Refer block-refer

Register block-register

Subscribe block-subscribe

Update block-update
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SIP rate limiting

Configurable threshold for SIPmessage rates per request method. Protects SIP servers from SIP overload and
DoS attacks.

SIP rate limiting

SIP

INVITE

REGISTER

SUBSCRIBE

NOTIFY

REFER

UPDATE

OPTIONS

MESSAGE

ACK

PRACK

INFO

SIP

FortiGates support rate limiting for the following types of VoIP traffic:

l Session Initiation Protocol (SIP)
l Skinny Call Control Protocol (SCCP) (most versions)
l Session Initiation Protocol for Instant Messaging and Presence Leveraging Extensions (SIMPLE).

You can use rate limiting of these VoIP protocols to protect the FortiGate and your network from SIP and SCCP
Denial of Service (DoS) attacks. Rate limiting protects against SIP DoS attacks by limiting the number of SIP
REGISTER and INVITE requests that the FortiGate receives per second. Rate limiting protects against SCCP
DoS attacks by limiting the number of SCCP call setup messages that the FortiGate receives per minute.

You configure rate limiting for a message type by specifying a limit for the number of messages that can be
received per second. The rate is limited per security policy. When VoIP rate limiting is enabled for a message
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type, if the a single security policy accepts more messages per second than the configured rate, the extra
messages are dropped and log messages are written when the messages are dropped.

Use the following command to configure a VoIP profile to limit the number of INVITEmessages accepted by each
security policy that the VoIP profile is added to 100 INVITEmessages a second:

config voip profile
edit VoIP_Pro_Name

config sip
set invite-rate 100

end
end

If you are experiencing denial of service attacks from traffic using these VoIP protocols, you can enable VoIP rate
limiting and limit the rates for your network. Limit the rates depending on the amount of SIP and SCCP traffic that
you expect the FortiGate to be handling. You can adjust the settings if some calls are lost or if the amount of SIP
or SCCP traffic is affecting FortiGate performance.

The table below lists all of the VoIP profile SIP rate limiting options. All of these options are set to 0 so are
disabled by default.

Blocking SIP OPTIONSmessages may prevent a redundant configuration from
operating correctly. See Supporting geographic redundancy when blocking OPTIONS
messages on page 3569 for information about resolving this problem.

Options for SIP rate limiting

SIP request message Rate Limiting CLI Option

ACK ack-rate

BYE bye-rate

Cancel cancel-rate

INFO info-rate

INVITE invite-rate

Message message-rate

Notify notify-rate

Options options-rate

PRACK prack-rate

Publish publish-rate

Refer refer-rate

Register register-rate
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SIP request message Rate Limiting CLI Option

Subscribe subscribe-rate

Update update-rate

Limiting the number of SIP dialogs accepted by a security policy
In addition to limiting the rates for receiving SIPmessages, you can use the following command to limit the
number of SIP dialogs (or SIP calls) that the FortiGate accepts.

config voip profile
edit VoIP_Pro_Name

config sip
set max-dialogs 2000

end
end

This command sets the maximum number of SIP dialogs that can be open for SIP sessions accepted by any
security policy that you add the VoIP profile to. The default setting of 0 does not limit the number of dialogs. You
can add a limit to control the number of open dialogs and raise and lower it as required. You might want to limit
the number of open dialogs for protection against SIP-based attackers opening large numbers of SIP dialogs.
Every dialog takes memory and FortiGate CPU resources to process. Limiting the number of dialogs may improve
the overall performance of the FortiGate. Limiting the number of dialogs will not drop calls in progress but may
prevent new calls from connecting.

SIP logging

You can enable SIP logging and logging of SIP violationsin a VoIP profile.

config voip profile
edit VoIP_Pro_Name

config sip
set log-call-summary enable
set log-violations enable

end
end

To view SIP log messages go to Log & Report > Forward Traffic.

Inspecting SIP over SSL/TLS (secure SIP)

Some SIP phones and SIP servers can communicate using SSL or TLS to encrypt the SIP signaling traffic. To
allow SIP over SSL/TLS calls to pass through the FortiGate, the encrypted signaling traffic has to be unencrypted
and inspected. To do this, the FortiGate SIP ALG intercepts and unencrypts and inspects the SIP packets. The
packets are then re-encrypted and forwarded to their destination.

Normally SIP over SSL/TLS uses port 5061. You can use the following command to change the port that the
FortiGate listens on for SIP over SSL/TLS sessions to port 5066:
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config system settings
set sip-ssl-port 5066

end

The SIP ALG supports full mode SSL/TLS only. Traffic between SIP phones and the FortiGate and between the
FortiGate and the SIP server is always encrypted.

You enable SSL/TLS SIP communication by enabling SSL mode in a VoIP profile. You also need to install the SIP
server and client certificates on your FortiGate and add them to the SSL configuration in the VoIP profile.
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SIP over SSL/TLS between a SIP phone and a SIP server

1. TCP session established between SIP phone and SIP server

2. SSL/TLS session established

between SIP phone and

FortiGate unit

4. SIP Phone sends a secure

REGSTER message to the

FortiGate unit

TCP SYNC

TCP SYNC ACK

TCP ACK

TLS ClientHello

TLS Handshake Messages

TLS Finished

SIP serverSIP Phone

5. The FortiGate unit decrypts the

REGSTER message, inspects it,

re-encrypts it, and forwards it to

the SIP server

7. The FortiGate unit decrypts the

200 OK response, inspects it,

re-encrypts it, and forwards it

to the phone

6. The SIP server sends a secure

200 OK response to the SIP Phone

3. SSL/TLS session established

between FortiGate unit and

SIP Server

TLS ClientHello

TLS Handshake Messages

TLS Finished
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Other than enabling SSL mode and making sure the security policies accept the encrypted traffic, the FortiGate
configuration for SSL/TLS SIP is the same as any SIP configuration. SIP over SSL/TLS is supported for all
supported SIP configurations.

Adding the SIP server and client certificates
A VoIP profile that supports SSL/TLS SIP requires one certification for the SIP server and one certificate that is
used by all of the clients. Use the following steps to add these certificates to the FortiGate. Before you start,
make sure the client and server certificate files and their key files are accessible from the management computer.

1. Go to System > Certificates and select Import.
2. Set Type to Certificate.
3. Browse to the Certificate file and the Key file and select OK.
4. Enter a password for the certificate and select OK.

The certificate and key are uploaded to the FortiGate and added to the Local Certificates List.
5. Repeat to upload the other certificate.
The certificates are added to the list of Local Certificates as the filenames you uploaded. You can add comments
to make it clear where its from and how it is intended to be used.

Adding SIP over SSL/TLS support to a VoIP profile
Use the following commands to add SIP over SSL/TLS support to the default VoIP profile. The following
command enables SSL mode and adds the client and server certificates and passwords, the same ones you
entered when you imported the certificates:

config voip profile
edit default

config sip
set ssl-mode full
set ssl-client-certificate "Client_cert"
set ssl-server-certificate "Server_cert"
set ssl-auth-client "check-server"
set ssl-auth-server "check-server-group"

end
end

Other SSL mode options are also available:

ssl-send-empty-frags {disable
| enable}

Enable to send empty fragments to avoid CBC IV attacks.
Compatible with SSL 3.0 and TLS 1.0 only. Default is enable.

ssl-client-renegotiation
{allow | deny | secure}

Control how the ALG responds when a client attempts to
renegotiate the SSL session. You can allow renegotiation or
block sessions when the client attempts to renegotiate. You can
also select secure to reject an SSL connection that does not
support RFC 5746 secure renegotiation indication. Default is
allow.
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ssl-algorithm {high | low |
medium}

Select the relative strength of the algorithms that can be
selected. You can select high, the default, to allow only AES or
3DES, medium, to allow AES, 3DES, or RC4 or low, to allow
AES, 3DES, RC4, or DES.

ssl-pfs {allow | deny |
regqure}

Select whether to allow, deny, or require perfect forward
secrecy (PFS). Default is allow.

ssl-min-version {ssl-3.0 |
tls-1.0 | tls-1.1}

Select the minimum level of SSL support to allow. The default is
ssl-3.0.

ssl-max-version {ssl-3.0 |
tls-1.0 | tls-1.1}

Select the maximum level of SSL support to allow. The default
is tls-1.1.

SIP and HA–session failover and geographic redundancy

FortiGate active-passive high availability (HA) supports SIP UDP session failover (also called stateful failover) if
the SIP sessions are processed by the SIP ALG. To support SIP UDP session failover, create a standard HA
configuration and select the enable Session Pick-up option.

SIP session failover replicates SIP states to all cluster units. If an HA failover occurs, all in-progress SIP UDP calls
(setup complete) and their RTP flows are maintained and the calls continue after the failover with minimal or no
interruption.

SIP calls being set up at the time of a failover may lose signaling messages. In most cases the SIP clients and
servers should use message retransmission to complete the call setup after the failover has completed. As a
result, SIP users may experience a delay if their calls are being set up when an HA failover occurs. But in most
cases the call setup should be able to continue after the failover.

SIP HA session failover
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In some cases, failover during call tear down can result in hanging RTP connections that can accumulate over
time and use up system memory. If this becomes a problem, you can set a time for the call-keepalive SIP
VoIP profile setting. This setting causes the FortiGate to terminate calls with no activity after the time limit has
exceeded. Range is 1 to 10,080 seconds. This options should be used with caution because it results in extra
FortiGate CPU overhead and can cause delay and jitter for the VoIP call. Also, the FortiGate terminates the call
without sending SIPmessages to end the call. And if the SIP endpoints send SIPmessages to terminate the call
they will be blocked by the FortiGate if they are sent after the FortiGate terminates the call.

SIP geographic redundancy
Maintains a active-standby SIP server configuration, which even supports geographical distribution. If the active
SIP server fails (missing SIP heartbeat messages or SIP traffic) FortiOS will redirect the SIP traffic to a secondary
SIP server. No special configuration is required for geographic redundancy, just standard HA configuration.

Geographic redundancy
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Server

SIP
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Supporting geographic redundancy when blocking OPTIONS messages
For some geographic redundant SIP configurations, the SIP servers may use SIP OPTIONSmessages as
heartbeats to notify the FortiGate that they are still operating (or alive). This is a kind of passive SIPmonitoring
mechanism where the FortiGate isn’t actively monitoring the SIP servers and instead the FortiGate passively
receives and analyzes OPTIONSmessages from the SIP servers.

If FortiGates block SIP OPTIONSmessages because block-options is enabled, the configuration may fail to
operate correctly because the OPTIONSmessages are blocked by one or more FortiGates.

However, you can work around this problem by enabling the block-geo-red-options application control list
option. This option causes the FortiGate to refresh the local SIP server status when it receives an OPTIONS
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message before dropping the message. The end result is the heartbeat signals between geographically
redundant SIP servers are maintained but OPTIONSmessages do not pass through the FortiGate.

Use the following command to block OPTIONSmessages while still supporting geographic redundancy:

config voip profile
edit VoIP_Pro_Name

config sip
set block-options disable
set block-geo-red-options enable

end
end

The block-options option setting overrides the block-geo-red-options
option. If block-options is enabled the FortiGate only blocks SIP OPTIONS
messages and does not refresh local SIP server status.

Support for RFC 2543-compliant branch parameters
RFC 3261 is the most recent SIP RFC, it obsoletes RFC 2543. However, some SIP implementations may use
RFC 2543-compliant SIP calls.

The rfc2543-branch VoIP profile option allows the FortiGate to support SIP calls that include an
RFC 2543-compliant branch parameter in the SIP Via header. This option also allows FortiGates to support SIP
calls that include Via headers that are missing the branch parameter.

config voip profile
edit VoIP_Pro_Name

config sip
set rfc2543-branch enable

end
end

SIP and IPS

You can enable IPS in security policies that also accept SIP sessions to protect the SIP traffic from SIP-based
attacks. If you enable IPS in this way then by default the pinholes that the SIP ALG creates to allow RTP and
RTCP to flow through the firewall will also have IPS enabled.

This inheritance of the IPS setting can cause performance problems if the RTP traffic volume is high since IPS
checking may reduce performance in some cases. Also if you are using network processor (NP) interfaces to
accelerate VoIP performance, when IPS is enabled for the pinhole traffic is diverted to the IPS and as a result is
not accelerated by the network processors.

You can use the following CLI command to disable IPS for the RTP pinhole traffic.

config voip profile
edit VoIP_Pro_Name

config sip
set ips-rtp disable

end
end
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SIP debugging

This chapter includes some information to help with debugging SIP configurations.

SIP debug log format
Assuming that diagnose debug console timestamp is enabled then the following shows the debug that
is generated for an INVITE if diag debug appl sip -1 is enabled:

2010-01-04 21:39:59 sip port 26 locate session for 192.168.2.134:5061 ->
172.16.67.192:5060
2010-01-04 21:39:59 sip sess 0x979df38 found for 192.168.2.134:5061 ->
172.16.67.192:5060
2010-01-04 21:39:59 sip port 26 192.168.2.134:5061 -> 172.16.67.192:5060
2010-01-04 21:39:59 sip port 26 read [(0,515)
(494e56495445207369703a73657276696365403139322e3136382e322e3130303a35303630205349502f322e300d0a5669613a2
05349502f322e302f554450203132372e302e312e313a353036313b6272616e63683d7a39684734624b2d363832372d3632302d3
00d0a46726f6d3a2073697070203c7369703a73697070403132372e302e312e313a353036313e3b7461673d36383237534950705
4616730303632300d0a546f3a20737574203c7369703a73657276696365403139322e3136382e322e3130303a353036303e0d0a4
3616c6c2d49443a203632302d36383237403132372e302e312e310d0a435365713a203120494e564954450d0a436f6e746163743
a207369703a73697070403132372e302e312e313a353036310d0a4d61782d466f7277617264733a2037300d0a5375626a6563743
a20506572666f726d616e636520546573740d0a436f6e74656e742d547970653a206170706c69636174696f6e2f7364700d0a436
f6e74656e742d4c656e6774683a20203132390d0a0d0a763d300d0a6f3d757365723120353336353537363520323335333638373
6333720494e20495034203132372e302e312e310d0a733d2d0d0a633d494e20495034203132372e302e312e310d0a743d3020300
d0a6d3d617564696f2036303031205254502f41565020300d0a613d7274706d61703a302050434d552f383030300d0a)(INVITE
sip:service@192.168.2.100:5060 SIP/2.0..Via: SIP/2.0/UDP
127.0.1.1:5061;branch=z9hG4bK-6827-620-0..From: sipp
%lt;sip:sipp@127.0.1.1:5061>;tag=6827SIPpTag00620..To: sut
%lt;sip:service@192.168.2.100:5060>..Call-ID: 620-6827@127.0.1.1..CSeq: 1
INVITE..Contact: sip:sipp@127.0.1.1:5061..Max-Forwards: 70..Subject: Performance
Test..Content-Type: application/sdp..Content-Length: 129....v=0..o=user1 53655765
2353687637 IN IP4 127.0.1.1..s=-..c=IN IP4 127.0.1.1..t=0 0..m=audio 6001 RTP/AVP
0..a=rtpmap:0 PCMU/8000..)]
2010-01-04 21:39:59 sip port 26 len 515
2010-01-04 21:39:59 sip port 26 INVITE '192.168.2.100:5060' addr 192.168.2.100:5060
2010-01-04 21:39:59 sip port 26 CSeq: 1 INVITE
2010-01-04 21:39:59 sip port 26 Via: UDP 127.0.1.1:5061 len 14 received 0 rport 0 0 branch 'z9hG4bK-
6827-620-0'
2010-01-04 21:39:59 sip port 26 From: 'sipp ;tag=6827SIPpTag00620' URI 'sip:sipp@127.0.1.1:5061' tag
'6827SIPpTag00620'
2010-01-04 21:39:59 sip port 26 To: 'sut ' URI 'sip:service@192.168.2.100:5060' tag ''
2010-01-04 21:39:59 sip port 26 Call-ID: '620-6827@127.0.1.1'
2010-01-04 21:39:59 sip port 26 Contact: '127.0.1.1:5061' addr 127.0.1.1:5061 expires 0
2010-01-04 21:39:59 sip port 26 Content-Length: 129 len 3
2010-01-04 21:39:59 sip port 26 sdp o=127.0.1.1 len=9
2010-01-04 21:39:59 sip port 26 sdp c=127.0.1.1 len=9
2010-01-04 21:39:59 sip port 26 sdp m=6001 len=4
2010-01-04 21:39:59 sip port 26 find call 0 '620-6827@127.0.1.1'
2010-01-04 21:39:59 sip port 26 not found
2010-01-04 21:39:59 sip port 26 call 0x97a47c0 open (collision (nil))
2010-01-04 21:39:59 sip port 26 call 0x97a47c0 open txn 0x979f7f8 INVITE dir 0
2010-01-04 21:39:59 sip port 26 sdp i: 127.0.1.1:6001
2010-01-04 21:39:59 sip port 26 policy id 1 is_client_vs_policy 1 policy_dir_rev 0
2010-01-04 21:39:59 sip port 26 policy 1 not RTP policy
2010-01-04 21:39:59 sip port 26 learn sdp from stream address
2010-01-04 21:39:59 sip port 26 call 0x97a47c0 sdp 172.16.67.198:43722
2010-01-04 21:39:59 sip port 26 call 0x97a47c0 txn 0x979f7f8 127.0.1.1:5061 find new address and port
2010-01-04 21:39:59 sip port 26 call 0x97a47c0 txn 0x979f7f8 127.0.1.1:5061 find new address and port
2010-01-04 21:39:59 sip port 26 call 0x97a47c0 txn 0x979f7f8 127.0.1.1:5061 find new address and port
2010-01-04 21:39:59 sip port 30 write 192.168.2.134:5061 -> 172.16.67.192:5060 (13,539)
2010-01-04 21:39:59 sip port 30 write [(13,539)
(494e56495445207369703a73657276696365403137322e31362e36372e3139323a35303630205349502f322e300d0a5669613a2
05349502f322e302f554450203137322e31362e36372e3139383a35323036353b6272616e63683d7a39684734624b2d363832372
d3632302d300d0a46726f6d3a2073697070203c7369703a73697070403137322e31362e36372e3139383a34333732343e3b74616
73d363832375349507054616730303632300d0a546f3a20737574203c7369703a73657276696365403137322e31362e36372e313

FortiOS Handbook for FortiOS 5.6.7
Fortinet Technologies Inc.

3571



SIP debugging Chapter 34 - VoIP Solutions: SIP

9323a353036303e0d0a43616c6c2d49443a203632302d36383237403132372e302e312e310d0a435365713a203120494e5649544
50d0a436f6e746163743a207369703a73697070403137322e31362e36372e3139383a34333732350d0a4d61782d466f727761726
4733a2037300d0a5375626a6563743a20506572666f726d616e636520546573740d0a436f6e74656e742d547970653a206170706
c69636174696f6e2f7364700d0a436f6e74656e742d4c656e6774683a20203133380d0a0d0a763d300d0a6f3d757365723120353
3363535373635203233353336383736333720494e20495034203137322e31362e36372e3139380d0a733d2d0d0a633d494e20495
034203137322e31362e36372e3139380d0a743d3020300d0a6d3d617564696f203433373232205254502f41565020300d0a613d7
274706d61703a302050434d552f383030300d0a)(INVITE sip:service@172.16.67.192:5060 SIP/2.0..Via: SIP/2.0/UDP
172.16.67.198:52065;branch=z9hG4bK-6827-620-0..From: sipp ;tag=6827SIPpTag00620..To: sut ..Call-ID: 620-
6827@127.0.1.1..CSeq: 1 INVITE..Contact: sip:sipp@172.16.67.198:43725..Max-Forwards: 70..Subject:
Performance Test..Content-Type: application/sdp..Content-Length: 138....v=0..o=user1 53655765 2353687637
IN IP4 172.16.67.198..s=-..c=IN IP4 172.16.67.198..t=0 0..m=audio 43722 RTP/AVP 0..a=rtpmap:0
PCMU/8000..)]

SIP-proxy filter per VDOM
You can use the diagnose sys sip-proxy xxx command in a VDOM to get info about how SIP is
operating in each VDOM.

SIP-proxy filter command
Use the diagnose sys sip-proxy filter to filter diagnose information for the SIP ALG. The following
filters are available:

diag sys sip-proxy filter vd
diag sys sip-proxy filter dst-addr4
diag sys sip-proxy filter dst-addr6
diag sys sip-proxy filter dst-port
diag sys sip-proxy filter identity-policy
diag sys sip-proxy filter negate
diag sys sip-proxy filter policy
diag sys sip-proxy filter policy-type
diag sys sip-proxy filter profile-group
diag sys sip-proxy filter src-addr4
diag sys sip-proxy filter src-addr6
diag sys sip-proxy filter src-port
diag sys sip-proxy filter vd
diag sys sip-proxy filter voip-profile

You can clear, view and negate/invert the sense of a filter using these commands:

diag sys sip-proxy filter clear
diag sys sip-proxy filter list
diag sys sip-proxy filter negate

SIP debug setting
Control of the SIP debug output is governed by the following command

diagnose debug application sip <debug_level_int>

Where the <debug_level_int> is a bitmask and the individual values determine whether the listed items are
logged or not. The <debug_level_int> can be:

1 Configuration changes, mainly addition/deletion/modification of virtual domains.

2 TCP connection accepts or connects, redirect creation.
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4 Create or delete a session.

16 Any IO read or write.

32 An ASCII dump of all data read or written.

64 Include HEX dump in the above output.

128 Any activity related to the use of the FortiCarrier dynamic profile feature to determine
the correct profile-group to use.

256 Log summary of interesting fields in a SIP call.

1024 Any activity related to SIP geo-redundancy.

2048 Any activity related to HA syncing of SIP calls.

Display SIP rate-limit data
You can use the diagnose sys sip-proxy meters command to display SIP rate limiting data.

For the following command output rate 1 shows that the current (over last second) measured rate for
INVITE/ACK and BYTEwas 1 per second, the peak 1 shows that the peak rate recorded is 1 per second, the
max 0 shows that there is no maximum limit set, the count 18 indicates that 18 messages were received and
drop 0 indicates that none were dropped due to being over the limit.

diag sys sip-proxy meters
sip
sip vd: 0
sip policy: 1
sip identity-policy: 0
sip policy-type: IPv4
sip profile-group:
sip dialogs: 18
sip dialog-limit: 0
sip UNKNOWN: rate 0 peak 0 max 0 count 0 drop 0
sip ACK: rate 1 peak 1 max 0 count 18 drop 0
sip BYE: rate 1 peak 1 max 0 count 18 drop 0
sip CANCEL: rate 0 peak 0 max 0 count 0 drop 0
sip INFO: rate 0 peak 0 max 0 count 0 drop 0
sip INVITE: rate 1 peak 1 max 0 count 18 drop 0
sip MESSAGE: rate 0 peak 0 max 0 count 0 drop 0
sip NOTIFY: rate 0 peak 0 max 0 count 0 drop 0
sip OPTIONS: rate 0 peak 0 max 0 count 0 drop 0
sip PRACK: rate 0 peak 0 max 0 count 0 drop 0
sip PUBLISH: rate 0 peak 0 max 0 count 0 drop 0
sip REFER: rate 0 peak 0 max 0 count 0 drop 0
sip REGISTER: rate 0 peak 0 max 0 count 0 drop 0
sip SUBSCRIBE: rate 0 peak 0 max 0 count 0 drop 0
sip UPDATE: rate 0 peak 0 max 0 count 0 drop 0
sip PING: rate 0 peak 0 max 0 count 0 drop 0
sip YAHOOREF: rate 0 peak 0 max 0 count 0 drop 0
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